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0SAFETY PRECAUTIONS
Always read the precautions before using this product.
Also read this manual and the relevant manuals mentioned in this manual carefully, and use the product properly while 
paying full attention to safety.
Note that the precautions in this manual apply only to this product.
The safety precautions are divided into the following levels: warnings and cautions.

Note that failure to observe  CAUTION may lead to a serious accident depending on the circumstances.
Make sure to observe both warnings and cautions to ensure personal safety.
Ensure that this manual is easily accessible to all users of this product.

0[Test Operation Precautions]

0[Precautions for Using a Data Storage]

WARNING

CAUTION

Indicates that incorrect handling may cause hazardous conditions, 
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions, 
resulting in minor or moderate injury or property damage.

●Before testing the operation of a user-created screen (such as turning on or off a bit device, 
changing the current value of a word device, changing the set value or current value of a 
timer or counter, and changing the current value of a buffer memory), thoroughly read the 
manual to fully understand the operating procedure.
During the test operation, never change the data of the devices which are used to perform 
significant operation for the system.
Doing so may cause an accident due to an incorrect output or malfunction.

WARNING

●Do not remove the SD card from drive A while the SD card is being accessed by the GOT, 
or the GOT may stop processing for about 20 seconds.
During this stop, you cannot operate the GOT, and the functions running in the 
background, including the screen refresh, alarm, logging, and script, also stop.
This stop may affect the system operation, causing an accident.
Before removing the SD card, check that the SD card access LED is off.

●Do not remove the data storage from the file server (drive N) that is being accessed by the 
GOT, or the system operation may be affected.
Before removing the data storage, check the relevant system signal to make sure that the 
data storage is not being accessed.

●Do not remove the data storage from the GOT while the data storage is being accessed by 
the GOT, or the data storage and files may be damaged.
Before removing the data storage, check the SD card access LED, relevant system signal, 
or others to make sure that the data storage is not being accessed.

WARNING

CAUTION
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0[Precautions for Remote Control]

0[Design Precautions]

0[Precautions for Exclusive Authorization Control]

●Remote control is available through a network by using GOT functions, including the 
SoftGOT-GOT link function, the remote personal computer operation function, the VNC 
server function, and the GOT Mobile function.
If you remotely operate control equipment using such functions, the field operator may not 
notice the remote operation, leading to an accident.
In addition, a communication delay or interruption may occur depending on the network 
environment, and remote control of control equipment cannot be performed normally in 
some cases.
Before using the above functions to perform remote control, fully grasp the circumstances 
of the field site and ensure safety.

●When operating the server (GOT) of the GOT Mobile function to disconnect a client, notify 
the operator of the client about the disconnection beforehand.
Not doing so may cause an accident.

WARNING

●To maintain the security (confidentiality, integrity, and availability) of the GOT and the 
system against unauthorized access, DoS*1 attacks, computer viruses, and other 
cyberattacks from unreliable networks and devices via network, take appropriate 
measures such as firewalls, virtual private networks (VPNs), and antivirus solutions.
Mitsubishi Electric shall have no responsibility or liability for any problems involving GOT 
trouble and system trouble by unauthorized access, DoS attacks, computer viruses, and 
other cyberattacks.
*1 DoS: A denial-of-service (DoS) attack disrupts services by overloading systems or 
exploiting vulnerabilities, resulting in a denial-of-service (DoS) state.

WARNING

●Before using the GOT network interaction function to prevent simultaneous operations 
from multiple pieces of equipment, make sure you understand the function.
You can enable or disable the exclusive authorization control of the GOT network 
interaction function for each screen. (For all screens, the exclusive authorization control is 
disabled by default.)
Properly determine the screens for which the exclusive authorization control is required, 
and set the control by screen.
A screen for which the exclusive authorization control is disabled is operable 
simultaneously from multiple pieces of equipment. Make sure to determine the operation 
period for each operator, fully grasp the circumstances of the field site, and ensure safety 
to perform operations.
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0CAUTIONS FOR USING THIS SOFTWARE
■1 Memory capacity and hard disk space of your personal computer

For the required memory capacity and hard disk space, refer to the following.
➟1.1.1 Operating environment

■2 Error massage displayed at this software startup or during data editing
[Operation will be terminated because of insufficient memory. Would you like to stop?]
If the above message appears, exit some running applications or restart Windows to free up memory.

■3 Changing device types
If a word device and any bit of the device are specified, changing the device type from the bit data type to a word data 
type may display [??] as the device.
In such a case, specify the device again.
Example) D0.b0 → D0, D0.b5 → ??

■4 Windows settings
If you change the Windows font size from the default, the panes and other items in GT Designer3 will appear improperly.
Use this software with the default Windows font size.
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0INTRODUCTION
Thank you for choosing Mitsubishi Electric Graphic Operation Terminal (GOT).
Before using the product, read this manual carefully and make sure you understand the functions and performance of the 
GOT for correct use.
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0How to Use Help
➟0 Displaying Help

0 Using Help

0Displaying Help

■1 Displaying Help from the menu
To display Help, select [Help] → [GT Designer3 Help] from the menu.

■2 Displaying the help page that corresponds to your current location within GT Designer3
To display the help page that corresponds to your current location within GT Designer3, press the [F1] key.

■3 Displaying a help page from a link
Click a link in a window or dialog to view the relevant help page.

■4 Precautions for displaying Help
(1) Relationship between a screen design software module and its Help

The GT Designer3 (GOT2000) module has its own Help.
To view Help for the GT Designer3 (GOT1000) module, change the screen design software module to GT Designer3 
(GOT1000).
To change the module, perform one of the following operations.

• Create a project.
• Open a GOT1000 project.
• Select [Project] → [Start GT Designer3 (GOT1000)] from the menu.

(2) Changing the screen design software module while Help is displayed
While Help is displayed, changing the screen design software module cannot switch Help.
To switch Help, change the screen design software module and then display Help.

Press the [F1] key while the [Style] tab is open in the [Switch] dialog. The help page that corresponds to the [Style] tab
in the [Switch] dialog is displayed.

Click the link. The relevant help page is displayed.
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(3) Starting GT Designer3
Starting GT Designer3 activates the screen design software module used last time.
(The first startup of GT Designer3 activates GT Designer3 (GOT2000).)
To change the screen design software module, perform one of the following operations.

• Create a project.
• Open a GOT1000 project.
• Select [Project] → [Start GT Designer3 (GOT1000)] from the menu.

0Using Help
Help is viewable using e-Manual Viewer.
For information on how to use e-Manual Viewer, refer to the following.

➟e-Manual Viewer Help
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0Manuals for GT Works3
The electronic manuals related to this product are installed together with the screen design software.
If you need the printed manuals, consult your local sales office.

■1 Manuals for GT Designer3 (GOT2000)

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:

• Required information can be cross-searched in multiple manuals.
• Other manuals can be accessed from the links in the manual.
• Hardware specifications of each part can be found from the product figures.
• Pages that users often browse can be bookmarked.
• Sample programs can be copied to the engineering tool.

(1) Screen design software-related manuals

(2) Connection manuals

(3) GT SoftGOT2000 manuals

(4) GOT2000 series user's manuals

Manual name
Manual number
(Model code)

Format

GT Works3 Installation Instructions - PDF

GT Designer3 (GOT2000) Screen Design Manual
SH-081220ENG
(1D7ML9)

PDF
e-Manual

GT Converter2 Version3 Operating Manual for GT Works3
SH-080862ENG
(1D7MB2)

PDF
e-Manual

GOT2000 Series MES Interface Function Manual for GT Works3 Version1 SH-081228ENG
PDF
e-Manual

Manual name
Manual number
(Model code)

Format

GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 
Version1

SH-081197ENG
(1D7MJ8)

PDF
e-Manual

GOT2000 Series Connection Manual (Non-Mitsubishi  Electric Products 1) For GT Works3 
Version1 SH-081198ENG

PDF
e-Manual

GOT2000 Series Connection Manual (Non-Mitsubishi  Electric Products 2) For GT Works3 
Version1 SH-081199ENG

PDF
e-Manual

GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, 
Peripherals) For GT Works3 Version1 SH-081200ENG

PDF
e-Manual

GOT2000 Series Handy GOT Connection Manual For GT Works3 Version1
SH-081867ENG
(1D7MS9)

PDF
e-Manual

GOT2000 Series Connection Manual (α2 Connection) for GT Works3 Version1 JY997D52301
PDF
e-Manual

Manual name
Manual number
(Model code)

Format

GT SoftGOT2000 Version1 Operating Manual SH-081201ENG
PDF
e-Manual

MELSOFT GT OPC UA Client Operating Manual SH-082174ENG PDF

Manual name
Manual number
(Model code)

Format

GOT2000 Series User's Manual (Hardware)
SH-081194ENG
(1D7MJ5)

PDF
e-Manual
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(5) GOT SIMPLE series user's manuals

(6) Manuals related to GT Works3 add-on projects

■2 Manuals for GT Designer3 (GOT1000)
Refer to the Help and manuals for GT Designer3 (GOT1000).

0Abbreviations, Generic Terms, and Model Icons
The following shows the abbreviations, generic terms, and model icons used in Help.

■1 GOT
(1) GOT2000 series

GOT2000 Series User's Manual (Utility)
SH-081195ENG
(1D7MJ6)

PDF
e-Manual

GOT2000 Series User's Manual (Monitor)
SH-081196ENG
(1D7MJ7)

PDF
e-Manual

Manual name Manual number Format

GOT SIMPLE Series User's Manual JY997D52901
PDF
e-Manual

Manual name
Manual number
(Model code)

Format

GT Works3 Add-on License for GOT2000 Enhanced Drive Control (Servo) Project Data 
Manual (Fundamentals)

SH-082072ENG
(1D7MV1)

PDF
e-Manual

GT Works3 Add-on License for GOT2000 Enhanced Drive Control (Servo) Project Data 
Manual (Screen Details)

SH-082074ENG
(1D7MV3)

PDF
e-Manual

Manual name
Manual number
(Model code)

Format

Abbreviations and generic terms Description
Meaning of icon

Available Unavailable

GT27

GT27-X GT2715-X
GT2715-XTBA
GT2715-XTBD

GT27-S

GT2712-S

GT2712-STBA
GT2712-STWA
GT2712-STBD
GT2712-STWD

GT2710-S
GT2710-STBA
GT2710-STBD

GT2708-S
GT2708-STBA
GT2708-STBD

GT27-V

GT2710-V

GT2710-VTBA
GT2710-VTWA
GT2710-VTBD
GT2710-VTWD

GT2708-V
GT2708-VTBA
GT2708-VTBD

GT2705-V GT2705-VTBD
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GT25

All GT25 models

GT25-W
GT2512-WX

GT2512-WXTBD
GT2512-WXTSD

GT2510-WX
GT2510-WXTBD
GT2510-WXTSD

GT2507-W
GT2507-WTBD
GT2507-WTSD

GT2507T-W GT2507T-WTSD

GT25-S

GT2512-S
GT2512-STBA
GT2512-STBD

GT2512F-S
GT2512F-STNA
GT2512F-STND

GT25-V

GT2510-V

GT2510-VTBA
GT2510-VTWA
GT2510-VTBD
GT2510-VTWD

GT2510F-V
GT2510F-VTNA
GT2510F-VTND

GT2508-V

GT2508-VTBA
GT2508-VTWA
GT2508-VTBD
GT2508-VTWD

GT2508F-V
GT2508F-VTNA
GT2508F-VTND

GT2505-V GT2505-VTBD

GT25HS-V
Handy GOT

GT2506HS-V GT2506HS-VTBD

GT2505HS-V GT2505HS-VTBD

GT23 GT23-V

GT2310-V
GT2310-VTBA
GT2310-VTBD

GT2308-V
GT2308-VTBA
GT2308-VTBD

Abbreviations and generic terms Description
Meaning of icon

Available Unavailable
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(2) GOT SIMPLE series

(3) GOT1000 series, GOT900 series, and GOT800 series

GT21

All GT21 models

GT21-W GT2107-W
GT2107-WTBD
GT2107-WTSD

GT21-Q GT2105-Q
GT2105-QTBDS
GT2105-QMBDS

GT21-R GT2104-R GT2104-RTBD

GT21-P

GT2104-P

GT2104-PMBD

GT2104-PMBDS

GT2104-PMBDS2

GT2104-PMBLS

GT2103-P

GT2103-PMBD

GT2103-PMBDS

GT2103-PMBDS2

GT2103-PMBLS

GT SoftGOT2000 GT SoftGOT2000 Version1

Abbreviations and generic terms Description
Meaning of icon

Available Unavailable

GS25 GS2512-WXTBD

GS21

GS21-W-N
GS2110-WTBD-N
GS2107-WTBD-N

GS21-W
GS2110-WTBD
GS2107-WTBD

Abbreviations and generic terms Description
Meaning of icon

Available Unavailable

GOT1000 Series GOT1000 Series -

GOT900 Series
GOT-A900 Series
GOT-F900 Series

-

GOT800 Series GOT-800 Series -

Abbreviations and generic terms Description
Meaning of icon

Available Unavailable

GS25 GS25

GS21 GS21
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■2 Communication unit

■3 Option unit

■4 Option

Abbreviations and generic terms Description

Bus connection unit

GT15-QBUS
GT15-QBUS2
GT15-ABUS
GT15-ABUS2
GT15-75QBUSL
GT15-75QBUS2L
GT15-75ABUSL
GT15-75ABUS2L

Serial communication unit
GT15-RS2-9P
GT15-RS4-9S
GT15-RS4-TE

MELSECNET/H communication unit
GT15-J71LP23-25
GT15-J71BR13

CC-Link IE TSN communication unit GT25-J71GN13-T2

CC-Link IE Controller Network communication unit GT15-J71GP23-SX

CC-Link IE Field Network communication unit GT15-J71GF13-T2

CC-Link communication unit GT15-J61BT13

Wireless LAN communication unit GT25-WLAN

Serial multi-drop connection unit GT01-RS4-M

Connection conversion adapter GT10-9PT5S

Field network adapter unit GT25-FNADP

Ethernet communication unit GT25-J71E71-100

RS-232/485 signal conversion adapter GT14-RS2T4-9P

Abbreviations and generic terms Description

Printer unit GT15-PRN

Video input unit GT27-V4-Z (A set of GT16M-V4-Z and GT27-IF1000)

RGB input unit
GT27-R2
GT27-R2-Z (A set of GT16M-R2-Z and GT27-IF1000)

Video/RGB input unit GT27-V4R1-Z (A set of GT16M-V4R1-Z and GT27-IF1000)

RGB output unit
GT27-ROUT
GT27-ROUT-Z (A set of GT16M-ROUT-Z and GT27-IF1000)

Digital video output unit GT27-VHOUT

Multimedia unit GT27-MMR-Z (A set of GT16M-MMR-Z and GT27-IF1000)

Video signal conversion unit GT27-IF1000

External I/O unit
GT15-DIO
GT15-DIOR

Sound output unit GT15-SOUT

SD card unit GT21-03SDCD

Abbreviations and generic terms Description

SD card

NZ1MEM-2GBSD
NZ1MEM-4GBSD
NZ1MEM-8GBSD
NZ1MEM-16GBSD
L1MEM-2GBSD
L1MEM-4GBSD

Battery
GT11-50BAT
GT15-BAT
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Protective sheet

GT27-15PSGC
GT25-12WPSGC
GT25-12PSGC
GT25-10WPSGC
GT25-10PSGC
GT25-08PSGC
GT21-07WPSGC
GT25T-07WPSVC
GT25-05PSGC
GT25-05PSGC-2
GT21-05PSGC
GT21-04RPSGC-UC
GT21-03PSGC-UC
GT21-04PSGC-UC
GT27-15PSCC
GT25-12WPSCC
GT25-12PSCC
GT25-10WPSCC
GT25-10PSCC
GT25-08PSCC
GT25-05PSCC
GT25-05PSCC-2
GT25-12PSCC-UC
GT25-10PSCC-UC
GT25-08PSCC-UC
GT21-07WPSCC
GT21-05PSCC
GT21-04RPSCC-UC
GT21-04PSCC-UC
GT21-03PSCC-UC
GT16H-60PSC
GT14H-50PSC

Antibacterial/antiviral protective sheet
GT25-12PSAC
GT25-10PSAC
GT25-08PSAC

Environmental protection sheet
GT25F-12ESGS
GT25F-10ESGS
GT25F-08ESGS

Protective cover for oil

GT20-15PCO
GT20-12PCO
GT20-10PCO
GT20-08PCO
GT21-12WPCO
GT21-10WPCO
GT21-07WPCO
GT25T-07WPCO
GT25-05PCO
GT25-05PCO-2
GT05-50PCO
GT21-04RPCO
GT10-30PCO
GT10-20PCO

USB environmental protection cover
GT25-UCOV
GT25-05UCOV
GT21-WUCOV

Stand

GT15-90STAND
GT15-80STAND
GT15-70STAND
GT05-50STAND
GT25-10WSTAND
GT21-07WSTAND
GT25T-07WSTAND

Abbreviations and generic terms Description
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■5 Software
(1) Software related to GOT

(2) Software related to iQ Works

(3) Other software

Attachment

GT15-70ATT-98
GT15-70ATT-87
GT15-60ATT-97
GT15-60ATT-96
GT15-60ATT-87
GT15-60ATT-77
GT21-04RATT-40

Panel-mounted USB port extension
GT14-C10EXUSB-4S
GT10-C10EXUSB-5S

Connector conversion box
GT16H-CNB-42S
GT16H-CNB-37S
GT11H-CNB-37S

Emergency stop switch guard cover
GT16H-60ESCOV
GT14H-50ESCOV

Wall-mounting attachment GT14H-50ATT

Abbreviations and generic terms Description

GT Works3 SW1DND-GTWK3-J, SW1DND-GTWK3-E, SW1DND-GTWK3-C

GT Designer3 Version1 Screen design software GT Designer3 for GOT2000 and GOT1000 series

GT Designer3
Screen design software for GOT2000 series included in GT Works3

GT Designer3 (GOT2000)

GT Designer3 (GOT1000) Screen design software for GOT1000 series included in GT Works3

Speech synthesis license GT Works Text to Speech License (SW1DND-GTVO-M)

Add-on license GT Works3 add-on license for GOT2000 enhanced drive control (servo) project 
data (SW1DND-GTSV-MZ)

GENESIS64 Advanced GENESIS64 server application (GEN64-APP)

GENESIS64 Basic SCADA GENESIS64 server application (GEN64-BASIC)

GENESIS64 Generic term of GENESIS64 Advanced and GENESIS64 Basic SCADA

GOT Mobile function license for GT SoftGOT2000 License required to use the GOT Mobile function with GT SoftGOT2000 
(SGT2K-WEBSKEY-□)

GT Simulator3 Screen simulator GT Simulator3 for GOT2000, GOT1000, and GOT900 series

GT SoftGOT2000 GOT2000 compatible HMI software GT SoftGOT2000

GT OPC UA Client MELSOFT GT OPC UA Client (SW1DNN-GTOUC-MD)

GT Converter2 Data conversion software GT Converter2 for GOT1000 and GOT900 series

GT Designer2 Classic Screen design software GT Designer2 Classic for GOT900 series

GT Designer2 Screen design software GT Designer2 for GOT1000 and GOT900 series

DU/WIN Screen design software FX-PCS-DU/WIN for GOT-F900 series

Abbreviations and generic terms Description

iQ Works iQ Platform compatible engineering environment MELSOFT iQ Works

MELSOFT Navigator
Integrated development environment software included in SW□DND-IQWK (iQ 
Platform compatible engineering environment MELSOFT iQ Works)
(□ represents a version.)

MELSOFT iQ AppPortal SW□DND-IQAPL-M type integrated application management software
(□ represents a version.)

Abbreviations and generic terms Description

GX Works3
SW□DND-GXW3-E (-EA, -EAZ) type programmable controller engineering 
software
(□ represents a version.)

Abbreviations and generic terms Description
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■6 License key (for GT SoftGOT2000)

■7 Others

GX Works2
SW□DNC-GXW2-E (-EA, -EAZ) type programmable controller engineering 
software
(□ represents a version.)

Controller simulator

GX Simulator3 Simulation function of GX Works3

GX Simulator2 Simulation function of GX Works2

GX Simulator
SW□D5C-LLT-E (-EV) type ladder logic test tool function software package 
(SW5D5C-LLT (-V) or later versions)
(□ represents a version.)

GX Developer
SW□D5C-GPPW-E (-EV)/SW□D5F-GPPW (-V) type software package
(□ represents a version.)

GX LogViewer
SW□DNN-VIEWER-E type software package
(□ represents a version.)

MI Configurator
Configuration and monitor tool for Mitsubishi Electric industrial computers 
(SW□DNNMICONF-M)
(□ represents a version.)

PX Developer
SW□D5C-FBDQ-E type FBD software package for process control
(□ represents a version.)

MT Works2
Motion controller engineering environment MELSOFT MT Works2 (SW□DND-
MTW2-E)
(□ represents a version.)

MT Developer
SW□RNC-GSV type integrated start-up support software for motion controller 
Q series
(□ represents a version.)

CW Configurator
Setting/monitoring tools for the C Controller module and MELSECWinCPU 
(SW□DND-RCCPU-E)
(□ represents a version.)

MR Configurator2
SW□DNC-MRC2-E type servo configuration software
(□ represents a version.)

MR Configurator
MRZJW□-SETUP type servo configuration software
(□ represents a version.)

FR Configurator2
Inverter setup software (SW□DND-FRC2-E)
(□ represents a version.)

FR Configurator
Inverter setup software (FR-SW□-SETUP-WE)
(□ represents a version.)

NC Configurator2 CNC parameter setting support tool (FCSB1221)

NC Configurator CNC parameter setting support tool

FX Configurator-FP
Parameter setting, monitoring, and testing software package for FX3U-20SSC-
H (SW□D5CFXSSCE)
(□ represents a version.)

FX Configurator-EN-L FX3U-ENET-L type Ethernet module setting software (SW1D5-FXENETL-E)

FX Configurator-EN FX3U-ENET type Ethernet module setting software (SW1D5C-FXENET-E)

RT ToolBox2 Robot program creation software (3D-11C-WINE)

RT ToolBox3 Robot program creation software (3F-14C-WINE)

MX Component
MX Component Version□ (SW□D5C-ACT-E, SW□D5C-ACT-EA)
(□ represents a version.)

MX Sheet
MX Sheet Version□ (SW□D5C-SHEET-E, SW□D5C-SHEET-EA)
(□ represents a version.)

CPU Module Logging Configuration Tool CPU module logging configuration tool (SW1DNN-LLUTL-E)

Abbreviations and generic terms Description

License key GT27-SGTKEY-U

Abbreviations and generic terms Description

IAI IAI Corporation

Abbreviations and generic terms Description
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AZBIL Azbil Corporation

OMRON OMRON Corporation

KEYENCE KEYENCE CORPORATION

KOYO EI KOYO ELECTRONICS INDUSTRIES CO., LTD.

JTEKT JTEKT CORPORATION

SHARP Sharp Corporation

SHINKO Shinko Technos Co., Ltd.

CHINO CHINO CORPORATION

TOSHIBA TOSHIBA CORPORATION

SHIBAURA MACHINE SHIBAURA MACHINE CO., LTD.

PANASONIC Panasonic Corporation

PANASONIC IDS Panasonic Industrial Devices SUNX Co., Ltd.

HITACHI IES Hitachi Industrial Equipment Systems Co., Ltd.

HITACHI Hitachi, Ltd.

HIRATA Hirata Corporation

FUJI FUJI ELECTRIC CO., LTD.

MURATEC Muratec products manufactured by Murata Machinery, Ltd.

YASKAWA YASKAWA Electric Corporation

YOKOGAWA Yokogawa Electric Corporation

RKC RKC INSTRUMENT INC.

ALLEN-BRADLEY Allen-Bradley products manufactured by Rockwell Automation, Inc.

CLPA CC-Link Partner Association

GE GE Intelligent Platforms, Inc.

HMS HMS Industrial Networks

LS IS LS Industrial Systems Co., Ltd.

MITSUBISHI INDIA Mitsubishi Electric India Pvt. Ltd.

ODVA Open DeviceNet Vendor Association, Inc.

SCHNEIDER Schneider Electric SA

SICK SICK AG

SIEMENS Siemens AG

SCHNEIDER EJH Schneider Electric Japan Holdings Ltd.

PLC Programmable controller manufactured by its respective company

Control equipment Control equipment manufactured by its respective company

Temperature controller Temperature controller manufactured by its respective company

Indicating controller Indicating controller manufactured by its respective company

Controller Controller manufactured by its respective company

Industrial switch (for CC-Link IE TSN Class B) CC-Link IE TSN Class B (Synchronized Realtime Communication) hub 
certified by CC-Link Partner Association

Industrial switch (for CC-Link IE TSN Class A) CC-Link IE TSN Class A (Realtime Communication) hub certified by CC-Link 
Partner Association

CC-Link IE TSN-equipped module

Generic term for the following CC-Link IE TSN master/local modules and CC-
Link IE TSN Plus master/local module
• RJ71GN11-T2
• RJ71GN11-EIP
• FX5-CCLGN-MS

Abbreviations and generic terms Description
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0Graphics Mode Icons
The following explains the graphics mode icons used in this manual.

Example) To indicate the available graphics mode

Example) To indicate the difference between graphics modes

Icon Description

Without graphics mode icons Both GOT Graphic Ver.2 and GOT Graphic Ver.1 are available.

GOT Graphic Ver.2 is available.
Details of GOT Graphic Ver.2 are given under its icon.

GOT Graphic Ver.1 is available.
Details of GOT Graphic Ver.1 are given under its icon.

Graphics mode available 
for the described function or setting

Details of each graphics mode

GOT Graphic Ver.2

GOT Graphic Ver.1
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0Terminology
The following shows the terms used in Help.

Term Description

Object Function that operates on the screen according to the value of the specified device

Input object Touch switch object, numerical input object, text input object, or alarm display object

Attribute
Setting item of a figure or object
Example) Monitor device, font, and text color

Label System label, global label, or label (GT Designer3)

Window
Modeless window, which permits user operations on the other windows while it is open.
Example) [Environmental Setting] window

Dialog
Modal window, which does not permit user operations on the other windows while it is open.
Example) [Type Setting] dialog

Data storage SD card, USB memory, CF card in a card reader, or other storage media

Ethernet interface

GOT interface for Ethernet communication:
• Ethernet standard port
• Ethernet standard port 1
• Ethernet standard port 2
• Ethernet extended port

GT SoftGOT2000 (Single channel) GT SoftGOT2000 capable of monitoring channel No. 1 only

GT SoftGOT2000 (Multiple channels) GT SoftGOT2000 capable of monitoring channels No. 1 to No. 4
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1.1 Basic Description of GT Designer3

GT Designer3 is software to create screens for GOT2000 series and GOT1000 series.
This software enables you to create and simulate a project, and transfer data between the GOT and a personal computer.

GT Designer3 consists of the following drawing software.
• GT Designer3(GOT2000): Drawing software for GOT2000 series
• GT Designer3(GOT1000): Drawing software for GOT1000 series

For the project which cannot be edited or the operation in the drawing software in operation, the supported drawing 
software is started.
The title bar of the window indicates which drawing software you are operating.

Each drawing software has own Help.
Pressing [F1] key will display Help for the drawing software you are operating.

■1 Project creation
GT Designer3 manages the data used to operate the GOT for each project.
Set screens to be displayed on the GOT and functions which operate with the GOT for the created project.

➟2. CREATING A PROJECT

■2 Simulation
You can simulate the operations of the GOT set in the project being created with GT Designer3 on a personal computer 
using GT Simulator3.
You can simulate the project created with GT Designer3 using only GT Simulator3.
Projects for GOT2000 series, GOT1000 series, and GOT-A900 series GOTs can be simulated using only GT Simulator3.

➟3. SIMULATION

■3 Data transfer
Created projects and the data required for operating the GOT are written into the GOT from GT Designer3.
The resource data stored in the GOT can be read from the GOT to GT Designer3.
For the data transfer between GT Designer3 and the GOT, use a communication cable, network, or the data storage.

➟4. COMMUNICATING WITH GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Project creation
Simulation

Personal computer (GT Designer3)

Data transfer

GOT

The name of the drawing software in operation is displayed.
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1.1.1 Operating environment

The following shows the operating environment for GT Designer3.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Model Personal computer that Windows runs on.

OS (English, Simplified 
Chinese, Traditional Chinese, 
Korean, German, or Italian 
version)*1*2*3*4*5*6*7

• Microsoft Windows 11 Education (64 bit)
• Microsoft Windows 11 Enterprise (64 bit)
• Microsoft Windows 11 Pro (64 bit)
• Microsoft Windows 11 Home (64 bit)
• Microsoft Windows 10 Enterprise (32 bit, 64 bit) 
• Microsoft Windows 10 Pro (32 bit, 64 bit) 
• Microsoft Windows 10 Home (32 bit, 64 bit) 
• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 bit) (English OPK, or English OPK and a language pack for localization) 

CPU
• Windows 11: 64 bit-compatible processor with dual-core or more or System on a Chip (SoC)*8

• Other than Windows 11: Intel Core 2 Duo Processor 2.0 GHz or more recommended*8

Memory
• For Windows 11: 4 GB or more recommended
• For 64-bit OS other than Windows 11: 2 GB or more recommended
• For 32-bit OS other than Windows 11: 1 GB or more recommended

Display Resolution XGA (1024 × 768 dots) or higher

Hard disk space
• For installation: 5 GB or more recommended
• For execution: 512 MB or more recommended

Display color High Color (16 bits) or higher
1. FUNDAMENTALS OF GT Designer3
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*1 For installation, administrator privileges are required.
For startup, the standard user or administrator account is required.
To use GT Designer3 with another MELSOFT application that runs with administrator privileges, run GT Designer3 with 
administrator privileges.
If you change any setting of the personal computer while GT Designer3 is running, the change will not be applied to GT 
Designer3.

*2 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Change your desktop themes (fonts)
• Remote desktop
• Setting the size of text and illustrations on the screen to any size other than [Small-100%]

*3 Operation is not supported in an environment with the text cursor indicator turned on.
*4 The touch feature is not supported.
*5 Operation in a virtual environment such as Hyper-V is not supported.
*6 Tablet mode is not supported.
*7 Unified Write Filter is not supported.
*8 ARM6 and ARM32 are not supported.

Other software

To use the simulation function on a personal computer, one of the following software applications must be installed.
• GX Simulator3 (included in GX Works3 Version1.007H or later)
• GX Simulator2 (included in GX Works2 Version1.12N or later)
• GX Simulator Version5.00A or later
• MT Simulator2 (included in MT Works2 Version1.70Y or later)
The required software version depends on the controller to be simulated.

➟3. SIMULATION

To import tag information of an OPC UA server to GT Designer3, the following software must be installed.
• GT OPC UA Client

To use the document display function, the following software must be installed.
• Document Converter
• Ghostscript GPL9.55 (Free software)
To use the files of Microsoft Word, Microsoft Excel, or Microsoft PowerPoint, the following software also must be installed.
• PostScript printer driver supplied with Windows
• Microsoft Office 2003, Microsoft Office XP, Microsoft Office 2000 (Required only when the files of Microsoft Word, Microsoft 

Excel, or Microsoft PowerPoint are used)

To use the remote personal computer operation function (Ethernet), the following software must be installed.
• VNC server software
For the applicable UltraVNC version, refer to the following Technical Bulletin.
➟List of VNC Servers Supporting the Remote Personal Computer Operation (Ethernet) Function Validated to Operate with the 

GOT2000 Series(GOT-A-0110)
• Windows terminal server function (Windows Server 2003)
• Terminal service function software (RDPGateway(rdp2vnc))

To use the remote personal computer operation function (Serial), one of the following software must be installed.
• Remote Personal Computer Operation Driver (DMT-DD)
• Remote Personal Computer Operation Driver (TSC-DD)
• Remote Personal Computer Operation Driver (MES_2X)
Use the software compatible with the personal computer OS used for the remote personal computer operation function (Serial).

➟10.4.2 Specifications of the remote personal computer operation (Serial)

To use the VNC server function, the following software must be installed.
• VNC client software (UltraVNC1.3.8.1,1.1.9.6, 1.0.9.6.2, or 1.0.8.2)

To use the multimedia function, the following software must be installed.
• Multimedia Interaction Tool
• Multimedia Interaction FTP Service
• Quick Time Player or QuickTime 7 Pro

To display Help, the following software must be installed.
• e-Manual Viewer

To display PDF manuals, the following software must be installed.
• Adobe Reader7 or later recommended

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD drive
• For execution: mouse, keyboard
• For printing: printer
Use the following hardware when required.
• For simulation (Only when outputting the buzzer sound): Sound card, speaker

Item Description
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1.1 Basic Description of GT Designer3



1

FU
N

D
A

M
EN

TA
LS

 O
F 

G
T 

D
es

ig
ne

r3
Operating environment on iQ Works
When starting GT Designer3 from MELSOFT Navigator, the operating environment of GT Designer3 is same as 
that of MELSOFT Navigator.

➟iQ Works Installation Instructions

1.1.2 Supported models

GT Designer3 is compatible with the following GOTs.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT GOT type Model

GT27

GT27**-X (1024x768)
GT2715-XTBA
GT2715-XTBD

GT27**-S (800x600)

GT2712-STBA
GT2712-STWA
GT2712-STBD
GT2712-STWD
GT2710-STBA
GT2710-STBD
GT2708-STBA
GT2708-STBD

GT27**-V (640x480)

GT2710-VTBA
GT2710-VTWA
GT2710-VTBD
GT2710-VTWD
GT2708-VTBA
GT2708-VTBD

GT2705-V (640x480) GT2705-VTBD

GT25

GT25**-WX (1280x800)

GT2512-WXTBD
GT2512-WXTSD
GT2510-WXTBD
GT2510-WXTSD

GT25**-W (800x480)
GT2507-WTBD
GT2507-WTSD
GT2507T-WTSD

GT25**-S (800x600)

GT2512-STBA
GT2512-STBD
GT2512F-STNA
GT2512F-STND

GT25**-V (640x480)

GT2510-VTBA
GT2510-VTWA
GT2510-VTBD
GT2510-VTWD
GT2510F-VTNA
GT2510F-VTND
GT2508-VTBA
GT2508-VTWA
GT2508-VTBD
GT2508-VTWD
GT2508F-VTNA
GT2508F-VTND
GT2506HS-VTBD

GT2505-V (640x480)
GT2505-VTBD
GT2505HS-VTBD

GT23 GT23**-V (640x480)

GT2310-VTBA
GT2310-VTBD
GT2308-VTBA
GT2308-VTBD
1. FUNDAMENTALS OF GT Designer3
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GT21

GT2107-W (800x480)
GT2107-WTBD
GT2107-WTSD

GT2105-Q (320x240)
GT2105-QTBDS
GT2105-QMBDS

GT2104-R (480x272) GT2104-RTBD

GT2104-P (384x128)

GT2104-PMBD
GT2104-PMBDS
GT2104-PMBDS2
GT2104-PMBLS

GT2103-P (320x128)

GT2103-PMBD
GT2103-PMBDS
GT2103-PMBDS2
GT2103-PMBLS

GS25 GS25**-WX (1280x800) GS2512-WXTBD

GS21

GS21**-W-N (800x480)
GS2110-WTBD-N
GS2107-WTBD-N

GS21**-W (800x480)
GS2110-WTBD
GS2107-WTBD

GT SoftGOT2000 GT SoftGOT2000 GT SoftGOT2000 Version1

GOT GOT type Model
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1.1.3 List of the supported models for each function

The following shows the supported models for each function.

■1 Simulation

■2 Common setting

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Description Supported 
models

Simulation Simulates the project you are editing.

Function Description Supported 
models

Screen Switching Switches the screen displayed on the GOT.

Language Switching Switches the language displayed on the GOT.

Operation Log
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Logs the operation performed on the GOT.

Kana-Kanji/Pinyin Conversion
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Converts texts to kanji or Chinese (Simplified) on the GOT.

Startup Logo Sets the logo displayed at the GOT startup.

USB Mouse/Keyboard Function
Not available to GT25HS-V.
Only available to GT2107-W for GT21.
Operates the GOT with a USB mouse or USB keyboard.

Time Setting Sets the GOT time setting method.

FA Transparent Function Transfers data between the personal computer and a PLC CPU via 
the GOT.

SoftGOT-GOT Link Function Monitors the GOT by using the personal computer (GT 
SoftGOT2000).

Station No. Switching Switches the station number of the GOT monitoring target.

Buffer memory unit No. switching Switches the buffer memory unit No. of the GOT monitoring target.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■3 Figure

■4 Object function

GOT Network Interaction Controls pieces of equipment on the same network to prevent 
simultaneous operations.

Comment Register a character string to be displayed on an object.

Parts Register a figure or image to be displayed on the object.

Function Description Supported 
models

Text
Draws a text.
The drawn text is fixed.

Logo Text
Draws a logo text.
The drawn text is fixed.

Line Draws a line.

Line Freeform Draws a freeform line.

Rectangle Draws a rectangle.

Polygon Draws a polygon.

Circle Draws a circle.

Arc Draws an arc.

Sector Draws a sector.

Scale Draws a scale.

Piping Draws a piping.

Paint Fills the framed area of the figure on the screen.

Import Image Imports an image file into the screen.

Import DXF data Imports a DXF data into the screen.

Import IGES data Imports an IGES data into the screen.

Function Description Supported 
models

Touch Switch

Switch Touch switch with multiple functions

Bit Switch Touch switch to switch ON/OFF of a bit device

Word Switch Touch switch to change the value of a word device

Go To Screen Switch Touch switch to switch the screen

Change Station No. Switch Touch switch to switch the station No. of the GOT monitor target

Special Function Switch Touch switch to display the utility or the screen for the monitor 
function

Key window display switch Touch switch to display a key window

Key Code Switch Touch switch to enter a key code

Lamp

Bit Lamp Lamp controlled by the bit device

Word Lamp Lamp controlled by the word device

Lamp Area Lamp area controlled by the bit device

Numerical Display/Input

Numerical Display Object to display a device value (numeric value)

Numerical input Object to input the device value (numeric value)

Function Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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Text Display/Input

Text Display Object to display the device value (text)

Text Input Object to input the device value (text)

Date/Time Display

Date Display Object to display the date

Time Display Object to display the time

Comment Display

Bit Comment
Object to display the comments
The bit device controls the displayed comments.

Word Comment
Object to display the comments
The word device controls the displayed comments.

Simple Comment
Object to display the comments
The displayed comments are fixed.

Parts Display

Bit Parts
Object to display the parts
The bit device controls the displayed parts.

Word Parts
Object to display the parts
The word device controls the displayed parts.

Fixed Parts
Object to display the parts
The displayed parts are fixed.

Parts Movement

Bit Parts
Object to move the parts
The bit device controls the displayed parts.

Word Parts
Object to move the parts
The word device controls the displayed parts.

Fixed Parts
Object to move the parts
The displayed parts are fixed.

Historical Data List Display Object to display the history of the device values collected by the 
logging function

Alarm Display

Alarm Display (User)
Object to display the alarms collected by the user alarm 
observation.
Set the monitored alarm per project.

Alarm Display (System)
Object to display the alarms collected by the system alarm 
observation.
Set the monitored alarm per project.

Simple Alarm Display
Object to display the alarms collected by monitoring the device
Set the monitored alarm per object.

System Alarm Display
Object to display the alarms collected by monitoring the system
Set the monitored alarm per object.

Recipe Display (Record List)
Place an object to list the records of a recipe.
This object must be used in combination with the recipe function.

Function Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
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Graph

Line Graph Object to indicate the device values as a line graph.

Trend Graph Object to indicate the device values in chronological order as a 
graph.

Bar Graph Object to indicate the device values as a bar graph.

Statistics Bar Graph Object to indicate the ratio of each device value compared to the 
total value of multiple devices as a bar graph.

Statistics Pie Graph Object to indicate the ratio of each device value compared to the 
total value of multiple devices as a pie graph.

Scatter Graph Object to indicate the device values as a scatter graph with the X 
and Y coordinates representing two devices, respectively.

Historical Trend Graph Object to indicate, in chronological order as a graph, the device 
values collected by the logging function.

Graphical Meter

Sector Meter Place an object to display a device value on a sector meter.

Semicircle Meter Place an object to display a device value on a semicircle meter.

Bar (Vertical) Meter Place an object to display a device value on a vertical bar meter.

Bar (Horizontal) Meter Place an object to display a device value on a horizontal bar meter.

Meter

Level Place an object to display a device value by filling the specified 
area.

Panelmeter Place an object to display a device value on a meter.

Slider Object to specify the device value (numeric value) by sliding the 
knob along the bar.

Document Display Displays a document on the screen.

Video/RGB display object
Not available to GT2705-V.
Displays an RGB image on the screen.

Script parts
Place an object to create a script.
When the GOT displays the screen on which this object is placed, if 
the trigger condition for the created script is satisfied, the script runs.

Set Overlay Screen Overlays a screen on another screen.

Window Position Specifies the display position for overlap windows, superimpose 
windows, or key windows.

Key Window Object

Input Value Area Setting Object to display the value you are inputting.

Input Range Area Setting Object to display the available range for inputting values.

Input Maximum Value Area 
Setting

Object to display the available range for inputting the maximum 
value.

Input Minimum Value Area 
Setting

Object to display the available range for inputting the minimum 
value.

Previous Value Area Setting Object to display the previous value.

Function Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■5 Functions performed on the background of the GOT

Print

Numerical Print Place an object to print a device value (numerical value).

Text Print Place an object to print a device value (text).

Bit Comment Print
Place an object to print a comment.
A bit device controls the comment to be printed.

Word Comment Print
Place an object to print a comment.
A word device controls the comment to be printed.

Hyperlink

Only available to GT SoftGOT2000 (Multiple channels) for GT 
SoftGOT2000.
Place an object to access a website or a file in the GOT public 
folder, or make a phone call.

Function Description Supported 
models

Alarm

User Alarm Observation Collects the alarms by monitoring the device.

System Alarm Observation Collects the alarms by monitoring the system.

Alarm Popup Display Displays the collected alarms in a popup window.

Logging Collects device values.

Recipe Executes the batch write or batch read on multiple devices.

Device Data Transfer Transfers data between devices.

Trigger Action Executes the selected action by using the set device or sampling 
cycle as a trigger.

Time Action Executes the selected action by using the set time as the trigger.

Hard Copy Captures the operating screen of the GOT.

Script Controls the set action by using the script.

Function Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■6 Functions used with peripheral devices

Function Description Supported 
models

Barcode
Not available to GT25HS-V.
Uses a barcode reader on the GOT.

RFID
Not available to GT25HS-V.
Uses a RFID controller on the GOT.

Remote Personal Computer Operation (Ethernet) Operates the personal computer on the GOT via Ethernet.

Remote Personal Computer Operation (Serial)
Not available to GT2705-V.
Operates the personal computer on the GOT by using the RGB 
display function.

VNC Server
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Monitors the GOT by using the personal computer.

Video Display
Not available to GT2705-V.
Displays the images, which are taken with a video camera, on the 
GOT.

RGB Display
Not available to GT2705-V.
Displays the images, which are sent from the personal computer, on 
the GOT.

Multimedia
Not available to GT2705-V.
Records or plays the images, which are taken with the video 
camera, on the GOT.

External I/O function / Operation Panel function
Not available to GT25-W, GT2505-V, and GT25HS-V.
Uses an external I/O device, or an operation panel on the GOT.

Video output function
Not available to GT2705-V.
Outputs the GOT screen or a specified overlap window to an 
external display.

Report function
Not available to GT25HS-V.
Collects and prints device values.

Sound Output
Not available to GT2505-V and GT25HS-V.
Outputs the sound on the GOT.

Server / Client Monitors the device of the controller, which the GOT is monitoring, 
by using other personal computers or the GOTs.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23
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Mail Send Sends a mail from the GOT.

FTP Server Transfers a file between the GOT (FTP server) and the peripheral 
device (FTP client).

File transfer function

FTP transfer
Not available to GT2105-Q.
Transfers a file between the GOT (FTP client) and a peripheral (FTP 
server).

GOT internal transfer Copies or moves a file to another drive or folder within the GOT.

GOT Mobile function

It is recommended to use GT SoftGOT2000 (Multiple channels) for 
GT SoftGOT2000.
Monitors a controller through the GOT from tablets or other 
information devices.

MES Interface function

Sends an SQL statement from the GOT to a personal computer 
database.

➟GOT2000 Series MES Interface Function Manual for GT Works3 
Version1

Function Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
1. FUNDAMENTALS OF GT Designer3
1.1 Basic Description of GT Designer3

1 - 13



1.2 Checking the Followings before Drawing

➟1.2.1 BootOS, CoreOS and package data
1.2.2 Project
1.2.3 Screen types and the specifications
1.2.4 Specifications of drawing
1.2.5 Font specifications
1.2.6 Character codes supported by the GOT
1.2.7 Specifications of available devices
1.2.8 Drive configuration of the target GOT for data transfer

1.2.1 BootOS, CoreOS and package data

To activate the GOT, the following data are required.

■1 BootOS and CoreOS
The BootOS and the CoreOS are used to activate the GOT.
They are installed on the GOT by factory default.
To use additional functions, upgrading the BootOS and the CoreOS are required.
For the additional functions mentioned above, refer to the following.

➟12.17 Upgraded Additional Function List

■2 Package data
The package data consists of a project, system applications (standard functions and extended functions), and 
communication drivers.

• Project
Data of screens and settings that is configured with GT Designer3

➟1.2.2 Project
• System application (standard function)

Application that is required for operating the GOT and displaying the utility
• System application (extended function)

Application that is required for using some functions, such as the system monitor function and the logging function
• Communication driver

Driver that is required for the GOT to communicate with controllers

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Package data

System application
(extended function) Communication driver

System application
(standard function)Project
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1.2.2 Project

Project is the data of the screen and setting configured with GT Designer3.
Each created project is managed individually.
The project has two types: workspace format project, a single file format project.

➟■1 Workspace format project
■2 A single file format project

When you save the project on GT Designer3, select the format.
For the compatibility between GT Designer3 Version2 and other existing software, refer to the following.

➟12.13.1 Compatibility of projects

■1 Workspace format project

The workspace format project is the file format to manage multiple projects in the workspace.

The workspace format project consists of multiple folders and files as the figure below.

• Workspace management file (workspacelist.xml)
This is the management information of the workspace in a storage folder.

• Project management file (projectlist.xml)
This is the management information of the projects in the workspace.

• Project folder
This folder stores the project.

Migration, renaming, or deletion of the workspace format project
If you operate (migrate, rename, or delete) the folders or files in the workspace by using Windows Explorer or 
others, the project may not be opened.
Operate the project by using GT Designer3.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Workspace 1

· Project 1-1

· Project 1-2

· Project 1-3

Workspace 2

· Project 2-1

· Project 2-2

· Project 2-3

Workspace 3

· Project 3-1

· Project 3-2

· Project 3-3

workspacelist.xml

Workspace 

management file

projectlist.xml

Project 

management file

projectlist.xml

Project 

management file

Storage folder

Workspace folder 1 Workspace folder 2

Project 
folder 1-1

Project 
folder 1-2

Project 
folder 2-1

Project 
folder 2-2
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■2 A single file format project

A single file format project is the file format to manage the project as a single file.
Copy, migrate, or rename the files by using Windows Explorer or others.
A single file format project has the following extensions.

• GTX
File format that the project only is stored in a single file.

• GTXS
File format that the package data consisting of the project, the system applications and communication driver related 
to the project is stored in a single file.
With the fixed version of the project, system applications, and communication driver, they can be used on the GOT 
without any downgrade of their functions which are set in the project, regardless of the old version of GT Designer3 
which is used to transfer GTXS project to the GOT.
This provides the convenience when you save the project as a completed data.

• G2
File format which is used to store the project in the GOT or a data storage.

• GTCNV
File format which is used to convert the GOT800 project and others into the GOT2000 project with GT Converter2.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1.2.3 Screen types and the specifications

➟■1 Screen types
■2 Screen specifications
■3 Functions arrangeable on the screen

■1 Screen types

The following shows the relation between the screens created by GT Designer3 and screens displayed on the GOT.
➟(1) Screens created with GT Designer3

(2) Display order
(3) Overlap-display specifications

(1) Screens created with GT Designer3

The following screen types can be created with GT Designer3.

(a) Base screen
A screen that becomes the base of the GOT screen display.
The control of displaying a base screen is performed with a screen switching device.

(b) Window screen
A screen displayed as an overlap window , superimpose window, a key window, and a dialog window on the GOT.

• Superimpose window
A window superimposed on a base screen and displayed as a part of the base screen.
Up to two superimpose windows (superimpose window 1 and 2) can be displayed simultaneously.
The control of displaying the window screen is performed with a screen switching device.

• Overlap window
A pop-up window displayed over a base screen.
Up to five overlap windows (overlap window 1 to 5) can be displayed simultaneously.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Superimpose window

Key window
Dialog window

Overlap window

Screens created with GT Designer3 Screen displayed 
on the GOT

Window screen

348BA1254

Production status 
screen 1

Base screen

348BA1254

Production status 
screen 1

Base screen
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(GT23, GT21, and GS21 can display up to two overlap windows (overlap window 1 and 2) simultaneously.)
The display position of an overlap window can be moved with a touch operation or a display position specification 
device.
The control of displaying the window screen is performed with a screen switching device.

• Key window
A pop-up window displayed on a base screen for the input by the numerical input function.
The display position of the key window can be moved by the touch operation.
Two types of key windows are provided: standard key window and user-created key window.

• Dialog window
A window displaying error or warning messages, and the GOT system messages in the foreground.
While a dialog window is displayed, other screens cannot be operated.
For GT21 and GS21, even while a dialog window is displayed, other screens are operable.
The control of displaying the window screen is performed with a screen switching device.

(c) Report screen
A window for outputting the data by the report function.
This screen is not displayed on the GOT.

(d) Mobile screen (GT27, GT25, GT SoftGOT2000, GS25)
A screen to be displayed on information devices, such as a tablet, when the GOT Mobile function is used.
This screen is not displayed on the GOT.

(2) Display order

The following shows the order of the screens displayed on the GOT.

• Base screen
Displayed at the back.

• Superimpose window 1, 2
Superimposed on a base screen and displayed as a part of the base screen.

• Overlap window 1 to 5
Displayed on the front of a base screen.
When multiple overlap windows are displayed, a later displayed or the last operated window is displayed on the front.
The stacking order of overlap windows is settable in the [Environmental Setting] window ([Screen Switching/
Windows]) as well.

• Key window
Displayed on the front of a base screen and an overlap window.

• Dialog window
Displayed in the foreground of the displayed windows.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Superimpose window 1, 2

Key window

Dialog window

Overlap window 1 to 5

348BA1254

Production status 
screen 1

Base screen

Production status 

screen 1

A1254 B 348

Production status 

screen 1

A1254 B 348

Back

Front

System message

Display order on the GOT
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(3) Overlap-display specifications

(a) Display order of overlapping figures and objects
Overlapping figures and objects are displayed according to the order of layers they belong to.
The display order of objects between a base screen and superimposed window depends on the settings.

➟5.1.5 [Type Setting] dialog

(b) A base screen and a superimpose window
An input object on a base screen operates even when the object overlaps a superimpose window.
For GT21 and GS21, the input object that overlaps a superimpose window does not operate.
When input objects on a superimpose window and a base window overlap each other, both of the objects operate by 
touching.
(If you touch the input objects too quickly, only the input object on the superimpose window may operate.)

(c) An overlap window and a key window
• When hidden behind an overlap window or a key window, the figures and the objects are not displayed and the input 

objects do no work.
To check or operate the figures and the objects behind the overlap window, close or move the overlap window.

• A touch operation is invalid in the surrounding area of 16 dots from an overlap window or a key window with a title 
bar displayed.
When the title bar is hidden, the touch operation is valid in all the areas.
For GT21 and GS21, the touch operation is valid in all the areas regardless of whether the title bar is displayed or 
hidden.

■2 Screen specifications

The following shows the specifications of the screens created with GT Designer3.
➟(1) Base screen specifications

(2) Window screen specifications
(3) Report screen specifications
(4) Mobile screen specifications
(5) Layer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Overlap window 1

Overlap window 2Touch operation is invalid in this area.

Object for input (touch switch)
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(1) Base screen specifications

Model
Screen size (width × height) (dots)

Registrable number of 
screen

Registrable screen 
numberBase screen size expansion 

disabled
Base screen size expansion 

enabled *1

GT27**-X (1024x768)
Horizontal display: 1024 × 768
Vertical display: 768 × 1024

Horizontal display: 1024 × 768 to 
3000 × 3000
Vertical display: 768 × 1024 to 
3000 × 3000

4096

0 to 32767

GT27**-S (800x600)
Horizontal display: 800 × 600
Vertical display: 600 × 800

Horizontal display: 800 × 600 to 
3000 × 3000
Vertical display: 600 × 800 to 
3000 × 3000

GT27**-V (640x480)
Horizontal display: 640 × 480
Vertical display: 480 × 640

Horizontal display: 640 × 480 to 
3000 × 3000
Vertical display: 480 × 640 to 
3000 × 3000

GT2705-V (640x480)
Horizontal display: 640 × 480
Vertical display: 480 × 640

Horizontal display: 640 × 480 to 
3000 × 3000
Vertical display: 480 × 640 to 
3000 × 3000

GT25**-WX (1280x800)
Horizontal display: 1280 × 800
Vertical display: 800 × 1280

Horizontal display: 1280 × 800 to 
3000 × 3000
Vertical display: 800 × 1280 to 
3000 × 3000

GT25**-W (800x480)
Horizontal display: 800 × 480
Vertical display: 480 × 800

Horizontal display: 800 × 480 to 
3000 × 3000
Vertical display: 480 × 800 to 
3000 × 3000

GT25**-S (800x600)
Horizontal display: 800 × 600
Vertical display: 600 × 800

Horizontal display: 800 × 600 to 
3000 × 3000
Vertical display: 600 × 800 to 
3000 × 3000

GT25**-V (640x480)
Horizontal display: 640 × 480
Vertical display: 480 × 640

Horizontal display: 640 × 480 to 
3000 × 3000
Vertical display: 480 × 640 to 
3000 × 3000

GT2505-V (640x480)
Horizontal display: 640 × 480
Vertical display: 480 × 640

Horizontal display: 640 × 480 to 
3000 × 3000
Vertical display: 480 × 640 to 
3000 × 3000

GT23**-V (640x480)
Horizontal display: 640 × 480
Vertical display: 480 × 640

-

GT2107-W (800x480)
Horizontal display: 800 × 480
Vertical display: 480 × 800

-

2048

GT2105-Q (320x240)
Horizontal display: 320 × 240
Vertical display: 240 × 320

-

GT2104-R (480x272)
Horizontal display: 480 × 272
Vertical display: 272 × 480

-

GT2104-P (384x128)
Horizontal display: 384 × 128
Vertical display: 128 × 384

-

GT2103-P (320x128)
Horizontal display: 320 × 128
Vertical display: 128 × 320

-

GS25**-WX (1280x800)
Horizontal display: 1280 × 800
Vertical display: 800 × 1280

Horizontal display: 1280 × 800 to 
3000 × 3000
Vertical display: 800 × 1280 to 
3000 × 3000

4096

GS21**-W-N (800x480)
Horizontal display: 800 × 480
Vertical display: 480 × 800

-

2048

GS21**-W (800x480)
Horizontal display: 800 × 480
Vertical display: 480 × 800

-

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For GT27, GT25, and GS25, you can create base screens that are larger than the GOT screen by enabling the base screen 
size expansion.
To enable the base screen size expansion, select [Expand base screen sizes] in [Basic setting] in the [Type setting] dialog.
➟5.1.5 ■1 [Basic Setting]

(2) Window screen specifications

The display size of window screens depends on the window types.
The following shows the specifications for each window type.

GT SoftGOT2000
640 × 480 to 1920 × 1200
(The maximum size depends on 
set resolution.)

- 4096 0 to 32767

Model
Screen size (width × height) (dots)

Registrable number of 
screen

Registrable screen 
numberBase screen size expansion 

disabled
Base screen size expansion 

enabled *1

Model Screen size (width × height) (dots) Registrable number of 
screen

Registrable screen 
number

GT27**-X (1024x768)
Horizontal display: 16 × 2 to 1024 × 768
Vertical display: 16 × 2 to 768 × 1024

1024 0 to 32767

GT27**-S (800x600)
Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT27**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2705-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT25**-WX (1280x800)
Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GT25**-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT25**-S (800x600)
Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT25**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2505-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT23**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640x

GT2107-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT2105-Q (320x240)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2104-R (480x272)
Horizontal display: 16 × 2 to 480 × 272
Vertical display: 16 × 2 to 272 × 480

GT2104-P (384x128)
Horizontal display: 16 × 2 to 384 × 128
Vertical display: 16 × 2 to 128 × 384

GT2103-P (320x128)
Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GS25**-WX (1280x800)
Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GS21**-W-N (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GS21**-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT SoftGOT2000
16 × 2 to 1920 × 1200
(The maximum size depends on set resolution.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Superimpose window

Model Screen size (width × height) (dots) Number of displayable screens on one base screen

GT27**-X (1024x768)
Horizontal display: 16 × 2 to 1024 × 768
Vertical display: 16 × 2 to 768 × 1024

2

GT27**-S (800x600)
Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT27**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2705-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT25**-WX (1280x800)
Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GT25**-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT25**-S (800x600)
Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT25**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2505-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT23**-V (640x480)
Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2107-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT2105-Q (320x240)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2104-R (480x272)
Horizontal display: 16 × 2 to 480 × 272
Vertical display: 16 × 2 to 272 × 480

GT2104-P (384x128)
Horizontal display: 16 × 2 to 384 × 128
Vertical display: 16 × 2 to 128 × 384

GT2103-P (320x128)
Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GS25**-WX (1280x800)
Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GS21**-W-N (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GS21**-W (800x480)
Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT SoftGOT2000
16 × 2 to 1920 × 1200
(The maximum size depends on set resolution.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Overlap window

The maximum size of a window screen differs depending on the design selected in the [Screen Design] dialog and the 
display state of the screen title bar.
Example) When a basic-type screen design is selected

Example) When a classic-type screen design is selected

Model
Screen size (width × height) (dots) Number of displayable 

screens on one base 
screenWith a title bar Without a title bar

GT27**-X (1024x768)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 1024 × 725
Vertical display: 16 × 2 to 768 × 981

• For classic-type screen designs
Horizontal display: 16 × 2 to 1022 × 751
Vertical display: 16 × 2 to 766 × 1007

Horizontal display: 16 × 2 to 1024 × 768
Vertical display: 16 × 2 to 768 × 1024

5

GT27**-S (800x600)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 800 × 557
Vertical display: 16 × 2 to 600 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 583
Vertical display: 16 × 2 to 598 × 783

Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT27**-V (640x480)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2705-V (640x480)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

With a title bar Without a title bar

With a title bar Without a title bar
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GT25**-WX (1280x800)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 1280 × 757
Vertical display: 16 × 2 to 800 × 1237

• For classic-type screen designs
Horizontal display: 16 × 2 to 1278 × 783
Vertical display: 16 × 2 to 798 × 1263

Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

5

GT25**-W (800x480)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 800 × 437
Vertical display: 16 × 2 to 480 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 463
Vertical display: 16 × 2 to 478 × 783

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT25**-S (800x600)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 800 × 557
Vertical display: 16 × 2 to 600 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 583
Vertical display: 16 × 2 to 598 × 783

Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT25**-V (640x480)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2505-V (640x480)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT23**-V (640x480)
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

2

GT2107-W (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT2105-Q (320x240)
Horizontal display: 16 × 2 to 320 × 224
Vertical display: 16 × 2 to 240 × 304

Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2104-R (480x272)
Horizontal display: 16 × 2 to 480 × 240
Vertical display: 16 × 2 to 272 × 448

Horizontal display: 16 × 2 to 480 × 272
Vertical display: 16 × 2 to 272 × 480

GT2104-P (384x128)
Horizontal display: 16 × 2 to 384 × 108
Vertical display: 16 × 2 to 128 × 364

Horizontal display: 16 × 2 to 384 × 128
Vertical display: 16 × 2 to 128 × 384

GT2103-P (320x128)
Horizontal display: 16 × 2 to 320 × 96
Vertical display: 16 × 2 to 128 × 288

Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GS25**-WX (1280x800)

• For screen designs other than the 
classic-type ones
Horizontal display: 16 × 2 to 1280 × 757
Vertical display: 16 × 2 to 800 × 1237

• For classic-type screen designs
Horizontal display: 16 × 2 to 1278 × 783
Vertical display: 16 × 2 to 798 × 1263

Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

5

GS21**-W-N (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

2

GS21**-W (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

Model
Screen size (width × height) (dots) Number of displayable 

screens on one base 
screenWith a title bar Without a title bar
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GT SoftGOT2000

• For screen designs other than the 
classic-type ones
16 × 2 to 1920 × 1157

• For classic-type screen designs
16 × 2 to 1918 × 1183

(The maximum size depends on set 
resolution.)

16 × 2 to 1920 × 1200
(The maximum size depends on set 
resolution.)

5

Model
Screen size (width × height) (dots) Number of displayable 

screens on one base 
screenWith a title bar Without a title bar
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(c) Key window

The maximum size of a window screen differs depending on the design selected in the [Screen Design] dialog and the 
display state of the screen title bar.
Example) When a basic-type screen design is selected

Example) When a classic-type screen design is selected

Model
Screen size (width × height) (dots) Number of displayable 

screens on one base 
screenWith a title bar Without a title bar

GT27**-X (1024x768)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 1024 × 725
Vertical display: 16 × 2 to 768 × 981

• For classic-type screen designs
Horizontal display: 16 × 2 to 1022 × 751
Vertical display: 16 × 2 to 766 × 1007

Horizontal display: 16 × 2 to 1024 × 768
Vertical display: 16 × 2 to 768 × 1024

1

GT27**-S (800x600)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 800 × 557
Vertical display: 16 × 2 to 600 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 583
Vertical display: 16 × 2 to 598 × 783

Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT27**-V (640x480)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2705-V (640x480)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT25**-WX (1280x800)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 1280 × 757
Vertical display: 16 × 2 to 800 × 1237

• For classic-type screen designs
Horizontal display: 16 × 2 to 1278 × 783
Vertical display: 16 × 2 to 798 × 1263

Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

With a title bar Without a title bar

With a title bar Without a title bar
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GT25**-W (800x480)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 800 × 437
Vertical display: 16 × 2 to 480 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 463
Vertical display: 16 × 2 to 478 × 783

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

1

GT25**-S (800x600)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 800 × 557
Vertical display: 16 × 2 to 600 × 757

• For classic-type screen designs
Horizontal display: 16 × 2 to 798 × 583
Vertical display: 16 × 2 to 598 × 783

Horizontal display: 16 × 2 to 800 × 600
Vertical display: 16 × 2 to 600 × 800

GT25**-V (640x480)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2505-V (640x480)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 640 × 437
Vertical display: 16 × 2 to 480 × 597

• For classic-type screen designs
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT23**-V (640x480)
Horizontal display: 16 × 2 to 638 × 463
Vertical display: 16 × 2 to 478 × 623

Horizontal display: 16 × 2 to 640 × 480
Vertical display: 16 × 2 to 480 × 640

GT2107-W (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT2105-Q (320x240)
Horizontal display: 16 × 2 to 320 × 224
Vertical display: 16 × 2 to 240 × 304

Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2104-R (480x272)
Horizontal display: 16 × 2 to 480 × 240
Vertical display: 16 × 2 to 272 × 448

Horizontal display: 16 × 2 to 480 × 272
Vertical display: 16 × 2 to 272 × 480

GT2104-P (384x128)
Horizontal display: 16 × 2 to 384 × 108
Vertical display: 16 × 2 to 128 × 364

Horizontal display: 16 × 2 to 384 × 128
Vertical display: 16 × 2 to 128 × 384

GT2103-P (320x128)
Horizontal display: 16 × 2 to 320 × 96
Vertical display: 16 × 2 to 128 × 288

Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GS25**-WX (1280x800)

• For screen designs other than the classic-type ones
Horizontal display: 16 × 2 to 1280 × 757
Vertical display: 16 × 2 to 800 × 1237

• For classic-type screen designs
Horizontal display: 16 × 2 to 1278 × 783
Vertical display: 16 × 2 to 798 × 1263

Horizontal display: 16 × 2 to 1280 × 800
Vertical display: 16 × 2 to 800 × 1280

GS21**-W-N (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GS21**-W (800x480)
Horizontal display: 16 × 2 to 800 × 448
Vertical display: 16 × 2 to 480 × 768

Horizontal display: 16 × 2 to 800 × 480
Vertical display: 16 × 2 to 480 × 800

GT SoftGOT2000

• For screen designs other than the classic-type ones
16 × 2 to 1920 × 1157

• For classic-type screen designs
16 × 2 to 1918 × 1183

(The maximum size depends on set resolution.)

16 × 2 to 1920 × 1200
(The maximum size depends on set 
resolution.)

Model
Screen size (width × height) (dots) Number of displayable 

screens on one base 
screenWith a title bar Without a title bar
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(d) Dialog window

(3) Report screen specifications

The report window is for outputting the data by the report function.
For the specifications of the report screen, refer to the following.

➟10.11.2 Specifications of the report function

(4) Mobile screen specifications

The mobile screen is displayed on information devices, such as a tablet, when the GOT Mobile function is used.
For the specifications of the mobile screen, refer to the following.

➟10.19.2 ■3 Mobile screen

Model Screen size (width × height) (dots) Number of displayable screens on one base screen

GT27**-X (1024x768)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

1

GT27**-S (800x600)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT27**-V (640x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2705-V (640x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT25**-WX (1280x800)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT25**-W (800x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT25**-S (800x600)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT25**-V (640x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2505-V (640x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT23**-V (640x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2107-W (800x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2105-Q (320x240)
Horizontal display: 16 × 2 to 320 × 224
Vertical display: 16 × 2 to 240 × 304

GT2104-R (480x272)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT2104-P (384x128)
Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GT2103-P (320x128)
Horizontal display: 16 × 2 to 320 × 128
Vertical display: 16 × 2 to 128 × 320

GS25**-WX (1280x800)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GS21**-W-N (800x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GS21**-W (800x480)
Horizontal display: 16 × 2 to 320 × 240
Vertical display: 16 × 2 to 240 × 320

GT SoftGOT2000 16 × 2 to 320 × 240

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(5) Layer

A base screen and a window screen created with GT Designer3 consist of a front layer and a back layer.
Placing the figures and objects separately on the front layer and the back layer ensures that the GOT displays the figures 
and objects in the superimposition order created with GT Designer3.

• Front layer
The front layer is displayed as a transparent sheet. In the area where no figure or object is placed, the back layer is 
visible.

The transparent color setting is not available.

Set the transparent color of the front layer.
The part of the figures and objects, whose color is the same as the transparent color of the front layer, also becomes 
transparent.

• Back layer
The back layer is displayed behind the front layer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

348B
A 1254

348B
A 1254

Front layer

Back layer

Front layer + Back layer

GOT Graphic Ver.2

GOT Graphic Ver.1
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The layer specifications for window screens depend on the window screen display on the GOT.

For how to superimpose the figures and objects by using the layers or the screens for which superimposition by using 
the layer is enabled, refer to the following.

➟6.5.5 ■3 Superimposition

■3 Functions arrangeable on the screen

➟(1) Figure
(2) Object
(3) Functions performed on the background of the GOT

(1) Figure

The following figures can be drawn.
• Text
• Logo Text
• Line
• Line Freeform
• Rectangle
• Polygon
• Circle
• Arc
• Sector
• Scale
• Piping
• Paint
• Import Image
• Import DXF data
• Import IGES data

Figures with the lamp attribute are processed as a lamp object.

Model Specifications

GT27, GT25, GT SoftGOT2000, GS25

• Superimpose windows, overlap windows, and key windows
Figures and objects are arranged on the front layer and back layer. The display order on the 
GOT conforms to the overlap order on GT Designer3.

• Dialog windows
The front layer and back layer are combined into one layer on the GOT, and the object 
stacking order adjustment is applied.

The object stacking order adjustment is always enabled.

To enable the object stacking order adjustment, select [Adjust object display order in GOT 
to the one in GT Designer3] in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT23

• Superimpose windows
Figures and objects are arranged on the front layer and back layer. The display order on the 
GOT conforms to the overlap order on GT Designer3.

• Overlap windows, key windows, and dialog windows
The front layer and back layer are combined into one layer on the GOT, and the object 
stacking order adjustment is applied.

The object stacking order adjustment is always enabled.

To enable the object stacking order adjustment, select [Adjust object display order in GOT 
to the one in GT Designer3] in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.2

GOT Graphic Ver.1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Object

The maximum number of objects on one screen depends on the screen type.
If many objects are placed on a screen, refreshing the GOT screen may be delayed.

(a) Base screen
Up to 1024 objects can be placed.
Objects placed 1025th or later are not displayed on the GOT.
(For GT21 and GS21, up to 100 input objects can be placed, including the ones on the window screen currently 
displayed.)

(b) Window screen
Up to 512 objects can be arranged.
Objects arranged after the 513th objects are not displayed on the GOT.

(c) Report screen
For the specifications of the report screen, refer to the following.

➟10.11.2 Specifications of the report function

(d) Mobile screen
For the specifications of the mobile screen, refer to the following.

➟10.19.2 ■3 Mobile screen

The following shows the arrangeable objects and the maximum number of objects that can be set.

Function Maximum number of objects per screen

Touch Switch

Switch

• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Bit switch

Word switch

Go to screen switch

Change station No. switch

Special function switch

Key window display switch

Key code switch

Lamp

Bit Lamp
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen
Figures with the lamp attribute are included.

Word Lamp

Lamp Area

Numerical display/input
Numerical display • Base screen: 1024 objects per screen

• Window screen: 512 objects per screenNumerical input

Text display/input
Text display • Base screen: 1024 objects per screen

• Window screen: 512 objects per screenText input

Date/Time display
Date display • Base screen: 1024 objects per screen

• Window screen: 512 objects per screenTime display

Comment display

Bit comment
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Word comment

Simple comment

Parts display

Bit parts
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Word Parts

Fixed Parts

Parts Movement

Bit parts
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Word parts

Fixed parts

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Historical data list display

• 8 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 
GS25)

• 1 object per screen (GT21 and GS21)
(Any object from among a historical data list display, trend graph, 
scatter graph, and historical trend graph)

Alarm display

Alarm display (user)
• 33 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 

GS25)
• 1 object per screen (GT21 and GS21)

Alarm display (system)
• 8 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 

GS25)
• 1 object per screen (GT21 and GS21)

Simple alarm display
• 24 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 

GS25)
• 1 object per screen (GT21 and GS21)

System alarm display 1 object per screen

Recipe display (record list) 1 object per screen

Graph

Line graph 32 objects per screen

Trend graph

• 32 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 
GS25)
(Any object from among trend graphs and historical trend graphs)

• 1 object per screen (GT21 and GS21)
(Any object from among a historical data list display, trend graph, 
scatter graph, and historical trend graph)

Bar graph
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Statistics bar graph 32 objects per screen

Statistics pie graph per screen 32 objects per screen

Scatter graph

• 24 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 
GS25)

• 1 object per screen (GT21 and GS21)
(Any object from among a historical data list display, trend graph, 
scatter graph, and historical trend graph)

Historical trend graph

• 32 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 
GS25)
(Any object from among trend graphs and historical trend graphs)

• 1 object per screen (GT21 and GS21)
(Any object from among a historical data list display, trend graph, 
scatter graph, and historical trend graph)

Graphical meter

Sector meter

32 objects per screen
Semicircle meter

Vertical bar meter

Horizontal bar meter

Meter

Level
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Panelmeter
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Slider
• Base screen: 1024 objects per screen
• Window screen: 512 objects per screen

Document display 1 object per screen

Video/RGB display object 4 objects per screen

Script parts 32 objects per screen

Set overlay screen
• 2047 objects per screen (GT27, GT25, GT23, GT SoftGOT2000, and 

GS25)
• 5 objects per screen (GT21 and GS21)

Function Maximum number of objects per screen
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(3) Functions performed on the background of the GOT

Window Position

Overlap window 1 1 object per screen

Overlap window 2 1 object per screen

Overlap window 3 1 object per screen

Overlap window 4 1 object per screen

Overlap window 5 1 object per screen

Superimpose window 1 1 object per screen

Superimpose window 2 1 object per screen

Key window 1 object per screen

Key window object

Input value area setting 1 object per screen

Input range area setting 1 object per screen

Input maximum value area setting 1 object per screen

Input minimum value area Setting 1 object per screen

Previous value area setting 1 object per screen

Print

Numerical Print

➟10.11.2 Specifications of the report function
Text print

Bit Comment Print

Word Comment Print

Hyperlink 1024 objects per screen

Function Maximum number of objects per screen

Function Maximum number of actions per screen

Alarm popup display 1 object per screen

Trigger action (screen) 600 objects per screen

Screen script 256 objects per screen

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1.2.4 Specifications of drawing

■1 Screen and coordinate
The horizontal direction on the screen is regarded as the X coordinate, and the vertical direction the Y coordinate. The 
coordinate (X, Y) indicates the distance from the origin (0, 0) at the top-left of the screen.
The unit of the coordinate is dot.
Example 1) When GT27-S (800 × 600) is installed horizontally

Example 2) When GT27-S (800 × 600) is installed vertically

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

(0, 0)

(799. 599)

(400, 300)

X-axis

Y-axis

(400, 0)

(0, 300)

(0，0)

(599，799)

(300，400)

(300，0)

(0，400)

X-axis

Y-axis
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1.2.5 Font specifications

Available fonts differ depending on the figures and objects.
Check the available fonts in the setting of each figure and object.
You can also specify the character code for the text display, text input, and others.
For the Shift JIS code, the GOT can only display the JIS level 1 and level 2 characters.
The following shows available fonts with GT Designer3.

*1 For GT23, GT21, and GS21, the font type is set to the 16-dot standard font. 
Set a typeface (Gothic or Mincho) by project.

➟5.1.5 [Type Setting] dialog
*2 For GT2107-W and GS21-W-N, the font type is specified as the outline font.

Set a typeface (Kaisho or Gothic) by project.
➟5.1.5 [Type Setting] dialog

Classification Font type Font image KANJI region Supported 
models

Standard font

6 × 8 dots Not supported

12-dot Standard Supported

16-dot Standard (Mincho)*1 Supported

16-dot Standard (Gothic)*1 Supported

HQ font

12-dot HQ Mincho Supported

12-dot HQ Gothic Supported

16-dot HQ Mincho Supported

16-dot HQ Gothic Supported

TrueType font

TrueType Mincho Not supported

TrueType Gothic Not supported

TrueType Numerical (Gothic) Not supported

TrueType Numerical (7-
Segment) Not supported

Outline font

Outline Square style*2 Supported

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Outline Gothic*2 Supported

Windows font
TrueType font and OpenType 
font of Windows installed in a 
personal computer

Not supported

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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KANJI region is a region where Chinese characters are used (such as Japan and China).
Some Chinese characters look different depending on the region where Chinese characters are used.
The font that supports the specification of KANJI region can display Chinese characters of Unified CJK Ideographs of 
Unicode in the style of the specified region.
Unified CJK Ideographs are Chinese characters that consist of Chinese (Simplified), Chinese (Traditional), Japanese, 
and Korean, all of which are standardized in Unicode.
GT Designer3 is compatible with the following KANJI regions.

If the KANJI regions are specified for individual figure or object, Chinese characters of different KANJI regions can be 
displayed on the single screen, and comments for each KANJI region can be displayed by language switching.

■1 Detailed font specifications

The following shows detailed specifications of available fonts with GT Designer3.

○: Supported , ×: Unsupported

KANJI region Language Font image

Japan Japanese

China

Chinese (Simplified)

Chinese (Traditional)

Classification Font type Basic size and how to specify size Character 
pitch*1

Characte
r color*2

Character 
effect*3

Easily-
distinguishable 

font*6

Standard font

6 × 8 dots Fixed to 6 × 8 dots Fixed 65536 
colors

• Bold
• Shadow
• Engrave

×

12-dot Standard
• One-byte: 6 × 12 dots
• Two-byte: 12 × 12 dots
1 to 8 (integral multiple) for height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

16-dot Standard 
(Mincho)*5

• One-byte: 8 × 16 dots
• Two-byte: 16 × 16 dots
0.5 times or 1 to 8 times (integral multiple) for 
height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

16-dot Standard (Gothic)*5

• One-byte: 8 × 16 dots
• Two-byte: 16 × 16 dots
0.5 times or 1 to 8 times (integral multiple) for 
height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

HQ font

12-dot HQ Mincho
• One-byte: 6 × 12 dots
• Two-byte: 12 × 12 dots
2 to 8 times (even multiple) for height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

12-dot HQ Gothic
• One-byte: 6 × 12 dots
• Two-byte: 12 × 12 dots
2 to 8 times (even multiple) for height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

16-dot HQ Mincho
• One-byte: 8 × 16 dots
• Two-byte: 16 × 16 dots
2 to 8 times (even multiple) for height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

16-dot HQ Gothic
• One-byte: 8 × 16 dots
• Two-byte: 16 × 16 dots
2 to 8 times (even multiple) for height and width

Fixed 65536 
colors

• Bold
• Shadow
• Engrave

○

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 A character pitch is the width of character.
A proportional font is a font type that has different character widths for each character.

*2 For GT2104-P and GT2103-P, 32-level monochrome is used.
*3 The following shows an example of a style.

*4 The character pitch differs depending on the object on which the outline font is used.
*5 For GT23, GT21, and GS21, the font type is set to the 16-dot standard font.

Set a font (Gothic/Mincho) for each project.
➟5.1.5 [Type Setting] dialog

*6 The slashed zero and the crossbar I are used in this font, which distinguish themselves easily from other characters.
The following shows an example image when this setting is enabled.

*7 For GT21, the setting range for the height and width is 16 dots to 128 dots (in 4-dot units).
*8 Not available when Windows fonts are used for comment groups.
*9 For GT2107-W and GS21-W-N, the font type is specified as the outline font.

Set a typeface (Kaisho or Gothic) by project.
➟5.1.5 [Type Setting] dialog

(1) Standard font

The font specifications applied to 12-dot Standard, 16-dot Standard (Mincho), and 16-dot Standard (Gothic) differ 
depending on the combination of the following settings.

• [Standard language] in the [GOT Type Setting] dialog
Specify a language used as the standard language.

➟5.1.5 [Type Setting] dialog

TrueType font

TrueType Mincho 8 to 240 dots (set in 1 dot unit) for height and 
width Proportional 65536 

colors

• Bold
• Shadow
• Engrave

×

TrueType Gothic 8 to 240 dots (set in 1 dot unit) for height and 
width Proportional 65536 

colors

• Bold
• Shadow
• Engrave

×

TrueType Numerical 
(Gothic)

16 to 240 dots (set in 4 dot units) for height and 
width*7 Fixed 65536 

colors - ×

TrueType Numerical (7-
segment)

16 to 240 dots (set in 4 dot units) for height and 
width*7 Fixed 65536 

colors - ×

Outline font

Outline Square style*9 8 to 240 dots (set in 1 dot unit) for height and 
width

Fixed or 
proportional*4

65536 
colors

• Bold
• Shadow
• Engrave

×

Outline Gothic*9 8 to 240 dots (set in 1 dot unit) for height and 
width

Fixed or 
proportional*4

65536 
colors

• Bold
• Shadow
• Engrave

×

Windows font 8 to 240 dots (set in 1 dot unit) for height and 
width Proportional 65536 

colors

• Bold
• Shadow
• Engrave

• Italic*8

• Underline*8

×

Classification Font type Basic size and how to specify size Character 
pitch*1

Characte
r color*2

Character 
effect*3

Easily-
distinguishable 

font*6

No character effect

Bold

Shadow

Engrave

Italic

Underline

Italic + Underline

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [16dot Standard Font] of the [GOT Type Setting] dialog
Available to GT23, GT21, and GS21.
Specifies the font of [16dot Standard].

• [KANJI Region] for figures, objects and comments
Specify KANJI regions per unit such as figures, objects, and comments.

(a) 6 × 8 dots
A font that the ASCII code supports (0x20 to 0x7E).
Characters which the ASCII code does not support are displayed in one-byte rectangle.
On the GOT, characters in one-byte rectangle in a character string are not displayed.

(b) 12-dot Standard, 16-dot Standard (Mincho), and 16-dot Standard (Gothic) (12-dot Standard and 16-
dot Standard for GT23, GT21, and GS21)
Fonts that Unicode 2.1 supports.
Unicode surrogate pairs (character code: 0xD800 to 0xDBFF and 0xDC00 to 0xDFFF) are not supported.
Characters of the Latin-1 Supplement or the Latin Extended-A are displayed in one-byte characters.
The fonts differ depending on the standard language setting.

If the standard language and the KANJI region are specified, Unified CJK Ideographs can be displayed in Chinese 
characters of the specified KANJI region.

Font type [Standard language] and font Supported 
model

[12dot Standard]

• [Japanese], [English], [Korean(Hangul)]
The font is Gothic.

• [Chinese(Simplified)]
The font is Mincho.

• [Chinese(Traditional)]
The font is Gothic.

[16dot Standard Mincho]

• [Japanese], [English], [Korean(Hangul)]
The font is Mincho.

• [Chinese(Simplified)]
The font is Mincho.

• [Chinese(Traditional)]
The font is Gothic.

[16dot Standard Gothic]

• [Japanese], [English], [Korean(Hangul)]
The font is Gothic.

• [Chinese(Simplified)]
The font is Mincho.

• [Chinese(Traditional)]
The font is Gothic.

[16dot Standard]

The font varies depending on the setting of [16dot Standard Font] in the [GOT Type Setting] 
dialog.
• [Japanese], [English], [Korean(Hangul)]

The font is Gothic when [16dot Standard Font] is [Gothic].
The font is Mincho when [16dot Standard Font] is [Mincho].

• [Chinese(Simplified)]
The font is Mincho.

• [Chinese(Traditional)]
The font is Gothic.

[Standard language] Display of kanji

[Japanese],
[English],
[Korean(Hangul)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Japanese (Shift-JIS).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [China(GB)-Mincho]: Chinese (Simplified) (GB2312)
• [China(Big5)-Gothic]: Chinese (Traditional) (Big5)

[Chinese(Simplified)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Chinese (Simplified) (GB2312).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [Japanese]: Chinese characters of Japanese (Shift-JIS)
• [China(Big5)-Gothic]: Chinese (Traditional) (Big5)

[Chinese(Traditional)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Chinese (Traditional) (Big5).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [Japanese]: Chinese characters of Japanese (Shift-JIS)
• [China(GB)-Mincho]: Chinese (Simplified) (GB2312)

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(2) HQ font

A font with higher resolution than a standard font.

The font specifications applied to an HQ font differ depending on the following settings.
• [Standard language] in the [GOT Type Setting] dialog

Specify a language used as the standard language.
➟5.1.5 [Type Setting] dialog

• [KANJI Region] for figures, objects and comments
Specify KANJI regions per unit such as figures, objects, and comments.

(a) 12-dot HQ Mincho, 12-dot HQ Gothic, 16-dot HQ Mincho, 16-dot HQ Gothic
Fonts that Unicode 2.1 supports.
Unicode surrogate pairs (character code: 0xD800 to 0xDBFF and 0xDC00 to 0xDFFF) are not supported.
Characters of the Latin-1 Supplement or the Latin Extended-A are displayed in one-byte characters.
The fonts differ depending on the standard language setting.

• [Japanese], [English], [Korean(Hangul)]
The font for 12-dot HQ Mincho and 16-dot HQ Mincho is Mincho.
The font for 12-dot HQ Gothic and 16-dot HQ Gothic is Gothic.

• [Chinese(Simplified)]
The characters are displayed in Mincho.

• [Chinese(Simplified)]
The characters are displayed in Gothic.

If the standard language and the KANJI region are specified, Unified CJK Ideographs can be displayed in Chinese 
characters of the specified KANJI region.

(3) TrueType font

(a)  TrueType Mincho, TrueType Gothic
Fonts that Unicode 2.1 supports.
Unicode surrogate pairs (character code: 0xD800 to 0xDBFF and 0xDC00 to 0xDFFF) are not supported.
Characters of the Latin-1 Supplement or the Latin Extended-A are displayed in one-byte characters.
Characters of Unified CJK Ideographs are displayed in Chinese characters of Japanese.

(b)  TrueType Numerical (Gothic), TrueType Numerical (7-Segment)
Fonts that the ASCII code supports (0x2B to 0x3A, 0x41 to 0x46, 0x4E, 0x6F).
These fonts are available only for displaying numerical values.

Standard font Display of kanji

[Japanese],
[English],
[Korean(Hangul)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Japanese (Shift-JIS).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [China(GB)-Mincho]: Chinese (Simplified) (GB2312)
• [China(Big5)-Gothic]: Chinese (Traditional) (Big5)

[Chinese(Simplified)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Chinese (Simplified) (GB2312).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [Japanese]: Chinese characters of Japanese (Shift-JIS)
• [China(Big5)-Gothic]: Chinese (Traditional) (Big5)

[Chinese(Traditional)]

Characters of Unified CJK Ideographs are displayed in Chinese characters of Chinese (Traditional) (Big5).
When the following KANJI regions are specified for figures or objects, characters of Unified CJK Ideographs 
are displayed in Chinese characters of a specified KANJI region.
• [Japanese]: Chinese characters of Japanese (Shift-JIS)
• [China(GB)-Mincho]: Chinese (Simplified) (GB2312)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Standard font (12-dot Standard)

HQ font (12-dot HQ Gothic)
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(4) Outline font

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
A font with higher resolution than a standard font.

Fonts that Unicode 2.1 supports.
Unicode surrogate pairs (character code: 0xD800 to 0xDBFF and 0xDC00 to 0xDFFF) are not supported.
The outline font supports the display of Thai.
In addition, many curves are used in each character. Hence, if a small size is applied to a character, you may find difficulty 
in reading the character.
The recommended character size for displaying Thai is 20 dots or more.
When a standard language and a KANJI region are specified, Unified CJK ideographs can be displayed in Chinese 
characters or Japanese kanji characters according to the specified KANJI region.

Antialiasing smooths out the jagged text on the screen.

Antialiasing is always enabled.

To enable antialiasing, select [Enable the antialiasing to smooth jagged text edges] in the [Type Setting] dialog.
GT23 does not support antialiasing.

➟5.1.5 [Type Setting] dialog

(5) Windows font

The TrueType font and OpenType font of Windows installed to a personal computer.
Vertical fonts are unavailable.
Displayable characters, fonts, and character pitches differ depending on Windows fonts used.
When using Windows fonts, note the following points.

(a)  Opening a created project with another personal computer
When Windows font used in the project has not been installed to the personal computer, and if a set text is changed, a 
different font is applied.
If the computer to open the project does not have the used Windows font , install the font to the computer.

(b)  Using the Windows fonts installed during an operation of GT Designer3.
Restart GT Designer3 to use the Windows fonts installed during an operation of GT Designer3.

[Standard language] Display of kanji

[Japanese],
[English],
[Korean(Hangul)]

Unified CJK ideographs are displayed in Japanese kanji characters (Shift-JIS).
When one of the following KANJI regions is specified for a figure or object, Unified CJK ideographs are displayed 
in Chinese characters.
• [China(GB)-Mincho]: Simplified Chinese (GB2312 or GBK)
• [China(Big5)-Gothic]: Traditional Chinese (Big5)

[Chinese(Simplified)]

Unified CJK ideographs are displayed in Simplified Chinese characters (GB2312 or GBK).
When one of the following KANJI regions is specified for a figure or object, Unified CJK ideographs are displayed 
in Japanese kanji characters or Traditional Chinese characters.
• [Japanese]: Japanese kanji (Shift-JIS)
• [China(Big5)-Gothic]: Traditional Chinese (Big5)

[Chinese(Traditional)]

Unified CJK ideographs are displayed in Traditional Chinese characters (Big5).
When one of the following KANJI regions is specified for a figure or object, Unified CJK ideographs are displayed 
in Japanese kanji characters or Simplified Chinese characters.
• [Japanese]: Japanese kanji (Shift-JIS)
• [China(GB)-Mincho]: Simplified Chinese (GB2312 or GBK)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Standard font (12-dot Standard)

Outline font (Outline Gothic)

GOT Graphic Ver.2

GOT Graphic Ver.1
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■2 Applications and the recommended fonts

A font has individual imaging speed and the way of specifying the character size. Therefore, appropriate fonts differ 
depending on the applications.
The following shows the applications and the recommended fonts. Refer to the table as rough guides.

*1 [16dot Standard Mincho] and [16dot Standard Gothic] are replaced with [16dot Standard] for GT23.

■3 Displaying text on the GOT

➟(1) Project and font data
(2) Utility language

Application
Recommended fonts*1

Specifying character size by 1 dot unit. Specifying character size by magnification

Not switching a displayed text
(figures (characters), comment display (simple))

• TrueType Mincho
• TrueType Gothic
• Outline Square style
• Outline Gothic
• Windows font

• 6 × 8 dots
• 12-dot Standard
• 16-dot Standard (Mincho)
• 16-dot Standard (Gothic)
• 12-dot HQ Mincho
• 12-dot HQ Gothic
• 16-dot HQ Mincho
• 16-dot HQ Gothic

Switching and displaying a text with a comment
(comment display, alarm observation)

• Outline Square style
• Outline Gothic

• 12-dot Standard
• 16-dot Standard (Mincho)
• 16-dot Standard (Gothic)
• 12-dot HQ Mincho
• 12-dot HQ Gothic
• 16-dot HQ Mincho
• 16-dot HQ Gothic

Objects (numerical display, numerical input)
• Outline Square style
• Outline Gothic

• 6 × 8 dots
• 12-dot Standard
• 16-dot Standard (Mincho)
• 16-dot Standard (Gothic)
• 12-dot HQ Mincho
• 12-dot HQ Gothic
• 16-dot HQ Mincho
• 16-dot HQ Gothic
• TrueType Numerical (Gothic)
• TrueType Numerical (7-Segment)

Objects (text display, text input)
• Outline Square style
• Outline Gothic

• 6 × 8 dots
• 12-dot Standard
• 16-dot Standard (Mincho)
• 16-dot Standard (Gothic)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Project and font data

To display characters arranged with GT Designer3 on the screen of the GOT, install the font data of the font of the 
characters to the GOT together with the project (screen data).

When package data is written to the GOT, necessary font data is automatically incorporated into package data according 
to the standard language setting and the KANJI region setting.
The following shows the required settings for each font.

*1 Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

*2 For GT2107-W and GS21-W-N, restrictions are placed on the typeface data and KANJI region data in the GOT as shown 
below.

• Multiple typefaces of data cannot coexist in the GOT.
• Three or more KANJI regions of data cannot coexist in the GOT.

Classification Settings

Standard font

The font data is automatically incorporated into package data by configuring one of the following 
settings.
• Set [Standard Language] in the [Type Setting] dialog.
• Set [16dot Standard Font] (for GT23 only) in the [Type Setting] dialog.
• Set [KANJI Region] for a figure, object, or comment.

HQ font

The font data is automatically incorporated into package data by configuring one of the following 
settings.
• Set the HQ font for a figure or object.
• Select the HQ font in the comment attribute setting.

TrueType font The font data is automatically incorporated into package data when the TrueType font is set for an 
object or others.

Outline font*1*2

The alphanumeric/kana font data is automatically incorporated into package data by configuring one 
of the following settings.
• Select [Alphanumeric/Kana] in [Outline Font] in the [Type Setting] dialog.
• Set the outline font for a figure or object.

The font data of Japanese kanji or Chinese characters is automatically incorporated into package 
data by configuring one of the following settings.
• Select [Kanji] in [Outline Font] in the [Type Setting] dialog.
• Set the outline font for a figure or object.
• Set [KANJI Region] for a figure or object.

The font data of Hangul is automatically incorporated into package data by configuring one of the 
following settings.
• Select [Hangul] in [Outline Font] in the [Type Setting] dialog.
• Set the outline font for a figure or object.

Windows font The font data is automatically incorporated into package data when the Windows font is set for an 
object or others.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer (GT Designer3)

Data transfer

GOT

Project

+   Font data

Package data
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(2) Utility language

The following shows the relationship between the displayable languages in the utility and the required font data.

*1 Not supported by GT21 and GS21.

For how to add a system application to be installed on the GOT, refer to the following.
➟4.2 Setting a System Application to be Written to the GOT

■4 Precautions

(1) Chinese characters which cannot be displayed with a specified KANJI region
If a specified KANJI region does not have Chinese character to be displayed, the character is displayed in Chinese 
character of another KANJI region that has the corresponding Chinese character.
The system finds the alternative KANJI region in order of Japanese, Chinese (Simplified), and Chinese (Traditional).

(2) Precautions for enabling antialiasing

(a) Text width change
Enabling or disabling antialiasing may change the text width.
The set text may not appear entirely on a figure or object, or the margin of a figure or object may be increased.
Check the sizes of figures and objects after changing the antialiasing setting.

(b) Layers on which objects are placed
When antialiasing is enabled, place the object using an outline font on the back layer.
If you place such an object on the front layer, antialiasing may not be processed properly.

(3) Timing for reflecting the font setting on GT SoftGOT2000 or GT Simulator3
The following settings of the [Type Setting] dialog are reflected at the start of monitoring or simulation.

• [Graphics Setting]
• [Enable the antialiasing to smooth jagged text edges] in the [Type Setting] dialog

➟5.1.5 [Type Setting] dialog
If you change the setting after the start of monitoring or simulation, restart the relevant software.
If you open the project data without restarting the software, the characters cannot be displayed correctly in the specified 
font.

Displayable language in the utility Required font data

Japanese
One of the following system applications is required.
• [Standard Function]-[Standard Font]-[Japanese]
• [Extended Function]-[Standard Font]-[Japanese]

English The language can be selected regardless of the standard font installed on the GOT.

Chinese (Simplified)
One of the following system applications is required.
• [Standard Function]-[Standard Font]-[Chinese(Simplified)]
• [Extended Function]-[Standard Font]-[Chinese(Simplified)]

Chinese (Traditional)*1
One of the following system applications is required.
• [Standard Function]-[Standard Font]-[Chinese(Traditional)]
• [Extended Function]-[Standard Font]-[Chinese(Traditional)]

Korean*1 The language can be selected regardless of the standard font installed on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1.2.6 Character codes supported by the GOT

The GOT supports the following character codes.
• ASCII

• Unicode (UTF-16) *1

• Shift JIS
• GB (GB2312, GBK)
• Big5

• KS *2

*1 If any Unicode data other than UTF-16 data is used, the GOT converts the character code to UTF-16.
There are restrictions depending on the data used.

*2  Not available to GT21 and GS21.

1.2.7 Specifications of available devices

➟■1 Available devices and setting ranges
■2 Data type of devices

■1 Available devices and setting ranges

The following shows the devices that GT Designer3 can set and the setting ranges of the devices.

*1 Not available to GT SoftGOT2000.
*2 Not available to GT23, GT21, and GS21.
*3 Not available to GT2105-Q.
*4 Only available to GT SoftGOT2000.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device Setting range Device No. representation

GOT internal device

GOT bit register (GB) GB0 to GB65535 (GB0 to GB2047 for GT21 and 
GS21)

Decimal number

GOT data register (GD) GD0 to GD65535 (GD0 to GD2047 for GT21 and 
GS21)

GOT special register (GS) GS0 to GS2047

SoftGOT2000 internal 
device *4

SoftGOT bit register (SGB) SGB0 to SGB65535

SoftGOT data register (SGD) SGD0 to SGD65535

Gateway device (EG) *2 EG0 to EG32767

GOT Mobile device *2

GOT Mobile bit register 
(VGB) VGB0 to VGB32767

GOT Mobile data register 
(VGD) VGD0 to VGD32767

Controller device Depends on the controller. Depends on the controller.

System label Depends on the setting. -

Global label *2 Depends on the setting. -

Label (GT Designer3) Depends on the setting. -

OMRON NJ/NX tag *1*3 Depends on the setting. -

RSLogix 5000 tag *1*3 Depends on the setting. -

AB native tag *1*2 Depends on the setting. -

OPC UA Tag *4 Depends on the setting. -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) GOT internal devices (GB, GD, and GS)
Devices that the GOT has in itself.
The devices can be used regardless of a connection type of the GOT. However, they cannot be controlled in sequence 
programs by a controller.
If the GOT is powered off or reset, the GOT sets the GOT internal device values to 0.
The GOT internal device includes the GOT bit register, GOT data register, and GOT special register.

The GOT internal devices have the area where functions are assigned or use prohibited areas used by the system.
For details of the devices and use prohibited areas, refer to the following.

➟12.1 GOT Internal Device

(2) SoftGOT2000 internal devices (SGB and SGD)
SoftGOT2000 internal device refers to a data storage area used by GT SoftGOT2000.
SoftGOT2000 internal devices are usable for any connection type, but they cannot be controlled by the sequence 
program of a controller.
When you exit GT SoftGOT2000, these devices are reset to 0.
The SoftGOT2000 internal devices are classified into two types: SoftGOT bit registers and SoftGOT data registers.

The SoftGOT2000 internal devices are also usable to monitor the data collected by the data collector of Edgecross.
To monitor the collected data, assign the data to SoftGOT2000 internal devices in the Edgecross interaction function 
setting on GT SoftGOT2000.
For the Edgecross interaction function setting, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(3) Gateway device (EG)
Virtual devices used by the server/client function.
Controller devices can be assigned and the device values can be stored to the gateway devices.
The gateway devices can be monitored from other GOTs and personal computers. You can monitor the controller devices 
via the GOT indirectly.

➟10.13.3 How to use the gateway devices

Device Description

GOT bit register (GB)

Can be used as bit devices.
The devices come in useful if they are used in processing that does not need connection 
by way of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.

GOT data register (GD)

Can be used as word devices.
The devices come in useful if they are used in processing that does not need connection 
by way of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.

GOT special register (GS)

Special register that the GOT has in itself.
Internal information, communication status, and error information of the GOT are stored.
By monitoring the GOT special register, various GOT information can be checked and the 
GOT can be operated.

Device Description

SoftGOT bit register (SGB)

Can be used as bit devices.
The devices come in useful if they are used in processing that does not need connection 
by way of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.

SoftGOT data register (SGD)

Can be used as word devices.
The devices come in useful if they are used in processing that does not need connection 
by way of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.
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(4) GOT Mobile device (VGB, VGD)
The GOT Mobile device is a virtual device usable for a client.
Assign GOT internal devices (GB and GD) to GOT Mobile devices for a client. The GOT Mobile devices are used as 
internal devices for the client.
Multiple clients are controllable individually by assigning different GOT internal devices for each client.
The virtual device is not initialized at the start of monitoring a mobile screen. Therefore, the device holds the value that 
is stored immediately before the monitoring.

➟10.19.2 ■4 GOT Mobile device (VGB and VGD)

(5) Controller device
Devices a controller has.
The GOT can monitor the controller devices.
The devices that GT Designer3 can set differ depending on the controller.

➟12.3 Device Range and Settings of Mitsubishi Electric Equipment
12.4 Device Range and Settings of Each Controller

(6) System label
Label used commonly to each project in the workspace for iQ Works.
Assign a controller device to a system label before using the system label.
For setting the system label, refer to the following.

➟6.1.3 How to set system labels

(7) Global label
This label is used for connection to the following controllers.

• RCPU *1

• Motion CPU (MELSEC iQ-R series)
• Motion module
• LHCPU

Among the global labels settable in GX Works3, MT Developer2, or Motion Control Setting Function, the GOT can monitor 
the ones that permit access from external devices.

*1 The GOT cannot monitor the global labels of R00CPU, R01CPU, and R02CPU that do not support the settings to permit 
access to their labels from external devices.

For setting the global labels, refer to the following.
➟6.1.4 How to set global labels

(8) Label (GT Designer3)
This label is used on GT Desinger3 only.
To use labels (GT Designer3), assign devices to them on GT Designer3.
For setting the labels (GT Designer3), refer to the following.

➟6.1.5 How to set labels (GT Designer3)

(9) OMRON NJ/NX tag
This tag is created with OMRON programming software.
To use OMRON NJ/NX tags, import them to GT Designer3.
For information on how to set the OMRON NJ/NX tags, refer to the following.

➟6.1.7 How to set OMRON NJ/NX tags

(10)RSLogix 5000 tag
This is a tag created with ALLEN-BRADLEY programming software.
To use RSLogix5000 tags, import them to GT Designer3.
For setting the RSLogix5000 tags, refer to the following.

➟6.1.8 Using RSLogix 5000 tags

(11)AB native tag
This is a tag created with ALLEN-BRADLEY programming software.
To use AB native tags, import them to GT Designer3.
For setting the AB native tags, refer to the following.

➟6.1.9 How to set AB native tags
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(12)OPC UA Tag
This tag is created on an OPC UA server.
To use OPC UA tags, import them to GT Designer3.
For information on setting the OPC UA tags, refer to the following.

➟6.1.10 How to set OPC UA tags

■2 Data type of devices

The following shows the data types that are available for GT Designer3.

*1 When a value exceeding the number of digits to which a real number is accurate is set, the set value and the operating 
value differ.
For a real number, set the number of digits not exceeding the number of digits to which the real number is accurate.

*2 The real number precision is given to 6-digit.
*3 The real number precision is given to 14-digit.

Data type Description Data length Data range

Signed BIN8

Signed binary value

8 bits -128 to 127

Signed BIN16 16 bits -32768 to 32767

Signed BIN32 32 bits -2147483648 to 2147483647

Signed BIN64 64 bits -9223372036854775808 to 9223372036854775807

Unsigned BIN8

Unsigned binary value

8 bits 0 to 255

Unsigned BIN16 16 bits 0 to 65535

Unsigned BIN32 32 bits 0 to 4294967295

Unsigned BIN64 64 bits 0 to 18446744073709551615

BCD16

Binary coded decimal

16 bits 0 to 9999

BCD32 32 bits 0 to 99999999

BCD64 64 bits 0 to 9999999999999999

Real numbers (32 bits)*1 Single-precision floating-point number 32 bits ±(0, 1.17550e-38 to 3.40282e+38)*2

Real numbers (64 bits)*1 Double-precision floating-point number 64 bits ±(0, 2.2250738585073e-308 to 1.7976931348623e+308)*3

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1.2.8 Drive configuration of the target GOT for data transfer

➟■1 GT27
■2 GT25 and GS25
■3 GT23
■4 GT21 and GS21

■1 GT27

(1) Drive configuration
The following shows the drive configuration of the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Drive C

Drive A Drive B Drive E Drive F Drive G

GOT

Data storage

File server

Drive N

Built-in flash memory

Drive X *

Built-in RAM

Drive V

* When you open a project from drive C, 

   drive X becomes drive A.

＋

＋

Drive Name Description, Condition of use

Drive A Standard SD card
An area where projects, system applications (extended functions), and resource data are 
stored.
Insert an SD card to the SD card interface of the GOT to use the drive.

Drive B USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.

➟(2) Installing the data storage and assigning the drive to GT27

Drive C Built-in flash memory (user area)
An area where projects and system applications (extended functions) are stored.
Always available.

Drive E

USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.
The usable drives and the drive assignment depend on the GOT model.
For details, refer to the following.

➟(2) Installing the data storage and assigning the drive to GT27

Drive F

Drive G

Drive N Network drive
Folder on the file server (such as a personal computer) that is connected to the GOT by 
Ethernet.

➟5.3.15 Configuring the network drive settings ([Network Drive])

Drive V Built-in RAM (user work memory area)

An area where the image files written using the FTP server function are stored
The image files in this drive can be used only when switching the image of a parts display 
automatically.

➟8.8.2 ■5 Switching the image on a parts display object automatically

Drive X Current drive
A drive that is running a project. 
When you open a project from drive C, drive A becomes the current drive.
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For the specifications of the USB interface of the GOT or data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

(2) Installing the data storage and assigning the drive to GT27
The usable drives and the drive assignment depend on the GOT model.
When multiple data storages are connected to a USB interface through a USB hub or card reader, drives are assigned 
to the storages in the order they are recognized.

Connect the data storages in the order in which the drives are assigned to the storages as intended.

GOT

Drive assignment
Maximum number of 

connectable data storagesFirst data storage to the front 
USB interface (host)

First data storage to the rear 
USB interface (host)

The second or later data 
storage to each USB 

interface (host)

GT2715-XTBA
GT2715-XTBD
GT2712-STBA
GT2712-STBD
GT2710-STBA
GT2710-STBD
GT2710-VTBA
GT2710-VTBD
GT2708-STBA
GT2708-STBD
GT2708-VTBA
GT2708-VTBD
GT2705-VTBD

Drive E Drive B
Drive F
Drive G

4
(Up to three data storages 
to each USB interface)

GT2712-STWA
GT2712-STWD
GT2710-VTWA
GT2710-VTWD

- Drive B
Drive F
Drive G

3
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■2 GT25 and GS25

(1) Drive configuration
The following shows the drive configuration of the GOT.

For the specifications of the USB interface of the GOT or data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Drive C

Drive A Drive B Drive E Drive F Drive G

GOT

Data storage

File server

Drive N

Built-in flash memory

Drive X *

Built-in RAM

Drive V

* When you open a project from drive C, 

   drive X becomes drive A.

＋

＋

Drive Name Description, Condition of use

Drive A Standard SD card
An area where projects, system applications (extended functions), and resource data are 
stored.
Insert an SD card to the SD card interface of the GOT to use the drive.

Drive B USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.
The usable drives and the drive assignment depend on the GOT model.
For details, refer to the following.

➟(2) Installing the data storage and assigning the drive to GT25 and GS25

Drive C Built-in flash memory (user area)
An area where projects and system applications (extended functions) are stored.
Always available.

Drive E

USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.
The usable drives and the drive assignment depend on the GOT model.
For details, refer to the following.

➟(2) Installing the data storage and assigning the drive to GT25 and GS25

Drive F

Drive G

Drive N Network drive
Folder on the file server (such as a personal computer) that is connected to the GOT by 
Ethernet.

➟5.3.15 Configuring the network drive settings ([Network Drive])

Drive V Built-in RAM (user work memory area)

An area where the image files written using the FTP server function are stored
The image files in this drive can be used only when switching the image of a parts display 
automatically.

➟8.8.2 ■5 Switching the image on a parts display object automatically

Drive X Current drive
A drive that is running a project. 
When you open a project from drive C, drive A becomes the current drive.
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(2) Installing the data storage and assigning the drive to GT25 and GS25
The usable drives and the drive assignment depend on the GOT model.
When multiple data storages are connected to a USB interface through a USB hub or card reader, drives are assigned 
to the storages in the order they are recognized.

Connect the data storages in the order in which the drives are assigned to the storages as intended.

GOT

Drive assignment
Maximum number of 

connectable data storagesFirst data storage to the front 
USB interface (host)

First data storage to the rear 
USB interface (host)

The second or later data 
storage to each USB 

interface (host)

GT2512-STBA
GT2512-STBD
GT2510-VTBA
GT2510-VTBD
GT2508-VTBA
GT2508-VTBD

Drive E Drive B
Drive F
Drive G

4
(Up to three data storages 
to each USB interface)

GT2512-WXTBD
GT2512-WXTSD
GT2510-WXTBD
GT2510-WXTSD
GT2507-WTBD
GT2507-WTSD

- Drive B
Drive E
Drive F
Drive G

4

GT2512F-STNA
GT2512F-STND
GT2510-VTWA
GT2510-VTWD
GT2510F-VTNA
GT2510F-VTND
GT2508-VTWA
GT2508-VTWD
GT2508F-VTNA
GT2508F-VTND
GT2507T-WTSD

- Drive B
Drive F
Drive G

3

GT2505-VTBD
GT2506HS-VTBD
GT2505HS-VTBD

- Drive E
Drive F
Drive G

3

GS2512-WXTBD - Drive B
Drive E
Drive F
Drive G

4
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■3 GT23

(1) Drive configuration
The following shows the drive configuration of the GOT.

For the specifications of the USB interface of the GOT or data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

(2) Installing the data storage and assigning the drive to GT23
Up to four types of USB drives can be installed by using a USB hub or a card reader.
When multiple data storages are connected to a USB interface, drive B, E, F, and G are assigned to the storages in the 
order they are recognized.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT

Built-in flash memory

Data storage

Drive C

Drive A Drive B Drive E Drive F Drive G Drive X *

* When you open a project from drive C, 

   drive X becomes drive A.

＋

Drive Name Description, Condition of use

Drive A Standard SD card
An area where projects, system applications (extended functions), and resource data are 
stored.
Insert an SD card to the SD card interface of the GOT to use the drive.

Drive B USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.

➟(2) Installing the data storage and assigning the drive to GT23

Drive C Built-in flash memory (user area)
An area where projects and system applications (extended functions) are stored.
Always available.

Drive E

USB Drive

An area where projects, system applications (extended functions), and resource data are 
stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.

➟(2) Installing the data storage and assigning the drive to GT23

Drive F

Drive G

Drive X Current drive
A drive that is running a project. 
When you open a project from drive C, drive A becomes the current drive.
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■4 GT21 and GS21

(1) Drive configuration
The following shows the drive configuration of the GOT.

For the specifications of the USB interface of the GOT or data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

(2) Installing the data storage to GT21
To use drive A of GT2103-P, insert an SD card into the SD card unit.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Drive A Drive E Drive X *

Data storage

GOT

Built-in flash memory

Drive C

Built-in SRAM

Drive D

* When you open a project from drive C, 

   drive X becomes drive A.

＋

Drive Name Description, Condition of use

Drive A Standard SD card
An area where projects, system applications, and resource data are stored.
Insert an SD card to the SD card interface of the GOT to use the drive.
To use an SD card on GT2103-P, mount the SD card unit (GT21-03SDCD) on the GOT.

Drive C Built-in flash memory (user area)
An area where projects are stored.
Always available.

Drive D Built-in SRAM
An area where the resource data is stored.
Always available.
Not available to GT2103-P and GS21.

Drive E USB Drive

An area where projects, system applications, and resource data are stored.
Install a data storage to the USB interface (host) of the GOT to use the drive.
The following models do not have drive E.
• GT2105-Q
• GT2104-R
• GT2104-P
• GT2103-P
• GS21

Drive X Current drive
A drive that is running a project. 
When you open a project from drive C, drive A becomes the current drive.
1. FUNDAMENTALS OF GT Designer3
1.2 Checking the Followings before Drawing

1 - 53



1 - 54 1. FUNDAMENTALS OF GT Designer3
1.2 Checking the Followings before Drawing



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

2. CREATING A PROJECT
2.1 Startup and Exit of GT Designer3 . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 2
2.2 Screen Layout of GT Designer3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 5
2.3 Creating and Editing a Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 51
2.4 Setting a Screen Design. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 70
2.5 Creating, Opening, and Closing a Screen  . . . . . . . . . . . . . . . . . . . .2 - 78
2.6 Basic Operations of the Drawing Screen . . . . . . . . . . . . . . . . . . . . .2 - 88
2.7 Changing Screen Property . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 102
2.8 Managing the Created Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 136
2.9 Viewing the Image of the Created Screen  . . . . . . . . . . . . . . . . . . .2 - 138
2.10 Copying and Deleting Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 144
2.11 Performing a Data Check . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 146
2.12 Protecting a Project with a Security Key. . . . . . . . . . . . . . . . . . . . .2 - 151
2.13 Protecting a Project by Registering Users  . . . . . . . . . . . . . . . . . . .2 - 172
2.14 Printing or Outputting a Project to a File. . . . . . . . . . . . . . . . . . . . .2 - 186
2.15 Saving a Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2 - 204
2. CREATING A PROJECT
 

2 - 1



2.1 Startup and Exit of GT Designer3

➟2.1.1 Starting GT Designer3
2.1.2 Exiting GT Designer3
2.1.3 Switching the display language of GT Designer3

2.1.1 Starting GT Designer3

The following shows the procedure for starting GT Designer3.
Step 1 From the Windows start menu, select [MELSOFT] → [GT Works3] → [GT Designer3] to start GT Designer3. 

*1*2

*1 How to open the start menu differs depending on the Windows version.
Check how to operate Windows.

*2 For GT Works3 version 1.136S or earlier, [MELSOFT Application] appears instead of [MELSOFT].
Step 2 Select an operation in the [Select Project] dialog.

(1) Drawing software to be started
GT Designer3 consists of the following drawing software.

• GT Designer3(GOT2000): Drawing software for GOT2000 series
• GT Designer3(GOT1000): Drawing software for GOT1000 series

GT Designer3 startup will activate the drawing software used at the previous time.
For the project which cannot be edited or the operation in the drawing software in operation, the supported 
drawing software is started.

(2) Operating on iQ Works
Part of the function of iQ Works cannot be used with GT Designer3 when GT Designer3 is not started from 
MELSOFT Navigator.
Start GT Designer3 from MELSOFT Navigator.

■1 [Select Project] dialog

1) [New] button
Creates a new project.

➟2.3.1 Creating a project
2) [Utilize Data] button

Utilizes a sample project or existing project to create a new project.
➟11.1 Searching for Utilizable Data (Utilize Data)

3) [Open] button
Opens a saved project.

➟2.3.2 Opening a project
4) [Show this dialog when starting GT Designer3]

Displays the [Select Project] dialog at startup of GT Designer3.
Whether to display or hide the [Select Project] dialog at startup of GT Designer3 can be also selected in the 
[Operation] tab of the [Option] dialog.

➟11.10.3 Customizing the operation

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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2.1.2 Exiting GT Designer3

Exit GT Designer3 by performing either of the following operations.
• Select [Project] → [Exit] from the menu.
• Click the [×] button on the title bar of GT Designer3.

2.1.3 Switching the display language of GT Designer3

By switching the display language of GT Designer3, you can use GT Designer3 in multiple languages on one personal 
computer.
The following shows how to switch the display language.

Step 1 Select [View] → [Switch Display Language] from the menu to display the [Switch Display Language] dialog.

➟■1 [Switch Display Language] dialog
Step 2 Select a language to be switched to in [Display Language], and click the [OK] button.
Step 3 Exit GT Designer3.
Step 4 Start GT Designer3 again to switch the display language.

The display language of the Help and sample projects is also switched accordingly.
If you need the latest Help and sample projects, contact your local sales office.

■1 [Switch Display Language] dialog

1) [Switch Display Language]
Select a language to be switched to.

■2 Precautions
(1) Languages supported on the personal computer

When the personal computer does not support a language to be switched to, screen layouts collapse and characters 
become garbled on GT Designer3.
Install a language pack or others on the personal computer as needed.

(2) Restrictions on the display language switching
(a) Items to which the display language switching is not applied

The display language switching is not applied to the following items.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

Item Display specifications

Some right-click context menu items The display language depends on the OS language.

Setting items and buttons in some dialogs The display language depends on the OS language.

Manuals The display language depends on the language version of the manual installed.
2. CREATING A PROJECT
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(b) Display language for importing files
After exporting a file using the following functions, you cannot import the file to GT Designer3 whose display language is 
different.

• Wireless LAN setting
• Label group
• Comment group
• User alarm observation
• Logging
• Recipe
• Device data transfer

(c) File format of exported files
When display languages differ between GT Designer3 and the OS, export files in the Unicode text format.
CSV files may not be exported properly.

(d) Data browser
When starting multiple modules of GT Designer3, you cannot copy data between the modules whose display languages 
are different.

(e) Adding the supplemental fonts for each language on Windows 10
To perform the display language switching on Windows 10, add the supplemental fonts for the target language.
For information on how to add the supplemental fonts for each language, refer to the manual of your personal computer 
or Windows Help.

(3) Operation when multiple modules of GT Designer3 are started
The display language is shared among all modules of GT Designer3.
When the display language setting is changed, the setting change is reflected by exiting GT Desinger3 where the setting 
change is made.
The display language of the last exited GT Designer3 is applied when you newly start a GT Designer3 module.

Example) When exiting GT Designer3 (A) ([Display Language]: [English]), and then exiting GT Designer3 (B) ([Display 
Language]: [Japanese])
Japanese is applied as the display language when GT Designer3 (D) is newly started.

Japanese     →     English     →     Japanese

Display language applied 
on the new startup

[Display Language]: [English]

GT Designer3 (A)

1. Exit 2. Exit

For the already started module of GT Designer3, 
its display language is not changed.

3. Startup

1. 2.

Update Update

Apply

[Display Language]: [Japanese]

GT Designer3 (B)

[Display Language]: [Japanese]

GT Designer3 (C)

[Display Language]: [Japanese]

GT Designer3 (D)
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2.2 Screen Layout of GT Designer3

The following shows the screen layout of GT Designer3.

1) Title bar
Displays the software name.
The title bar displays a project name (workspace format) and a file name with a full path (single file format) according 
to the format in which the project is being edited.

2) Menu bar
GT Designer3 can be operated from pull-down menus.

➟2.2.1 Menus
3) Toolbar

GT Designer3 can be operated by buttons.
➟2.2.2 Toolbar and shortcut keys

4) Docking window
A window that can be docked with the screen of GT Designer3.
The docking location can be customized.

➟11.10.2 Customizing the docking window
The following shows the types of windows that can be docked.

Item Description

[Utilize Data (Screen)] window
Searches a screen of another project which can be utilized.

➟11.1 Searching for Utilizable Data (Utilize Data)

[Project] window
Displays the list of the settings of the whole project.

➟2.2.4 ■1 [Project] window

[System] window
Displays the list of settings such as the GOT type settings, environmental settings, and 
controller settings.

➟2.2.4 ■2 [System] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

4)

3)

8)

4)

4)

5)

6)

7)

3)
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5) Editor tab
Displays the tabs of the windows and screen editors which are displayed on the work window.

➟2.2.3 Editor tab, work window
6) Work window

Displays screen editors, the [Environmental Setting] window, the [GOT Setup] window, and other windows.
➟2.2.3 Editor tab, work window

7) Screen editor
Creates a screen to be displayed on the GOT by arranging figures and objects on the screen editor.

➟2.5 Creating, Opening, and Closing a Screen
8) Status bar

Displays the following contents according to the position of the mouse cursor, a selected figure, or object.
• Description of the item over which the mouse cursor is moved.
• The GOT type, color settings, and controller settings of the project being edited.
• Coordinates of a selected figure or object

[Screen] window
Lists created base screens, window screens, report screens, and mobile screens.
You can create or edit a base screen, window screen, report screen, or mobile screen.

➟2.2.4 ■3 [Screen] window

[Property] window
Displays the list of settings of a selected screen, figure, or object.
You can edit the settings without opening the setting dialog of a figure, object and others.

➟11.9 Checking and Editing Settings of Screens and Objects (Property Sheet)

[Library] window

Displays the list of figures and objects registered in the library.
You can utilize or edit the figures and objects and create a new figure or object in the 
library.

➟8.1 Using Objects in the Library

[Device Search] window
Search the project for matching devices, labels, or tags.

➟11.8.1 Searching for a device (Device search)

[Data Browser] window
Displays the list of the settings in the project.
You can search or edit the settings of a figure, object and others.

➟11.8.5 Searching for and editing a specific setting (Data Browser)

[Data Check List] window
Displays the list of data check results.

➟2.11.1 [Data Check List] window

[Output] window
Displays the list of the change history when the project is converted because of change of 
the GOT type or other reasons.

➟5.1.6 [Output] window

[Controller Type List] window
Displays the connection status of each channel.

➟5.5.1 ■6 [Controller Type List] window

[Data View] window
Displays the list of the figures and objects on the screen editor.
You can select a figure or object on the [Data View] window.

➟6.5.2 ■3 [Data View] window

[Screen Image List] window
Displays the icons of base screens, window screens, and mobile screens.
You can create or edit a base screen, window screen, or mobile screen.

➟2.8.1 [Screen Image List] window

[Category List] window

Displays the list of categories and figures and objects classified in each category.
You can edit a category and execute batch change to the settings of devices by the 
category.

➟11.7.4 [Category List] window

[Parts Image List] window
Displays the list of the images of registered parts.
You can create a new part or edit the existing parts.

➟5.9.5 [Parts Image List] window

[IP Address List] window
Displays the list of the IP addresses registered in the project.

➟11.8.6 Checking the IP addresses in the list (IP address list)

Item Description
2 - 6 2. CREATING A PROJECT
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2.2.1 Menus

➟■1 [Project]
■2 [Edit]
■3 [Search/Replace]
■4 [View]
■5 [Screen]
■6 [Common]
■7 [Figure]
■8 [Object]
■9 [Communication]
■10 [Diagnostics]
■11 [Tools]
■12 [Window]
■13 [Help]

■1 [Project]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[New] Creates a new project.

[Utilize Data] Searches projects that can be utilized.

[Open] Opens a saved project.

[Close] Closes the project being edited.

[Save] Overwrites the project being edited.

[Save As] Names and saves the project being edited.

[Delete] Deletes workspace format projects.

[Verify] Compares the project being edited with a saved 
project.

[Project information] Sets a project title and a creator's name.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Utilize Project] Utilizes data of saved projects.

[Import Other Data]

[Device Comment/Device Definition] Reads device comments.

[Global Label] Reads global labels.

[Tag]

[OMRON NJ/NX Tag]
Not available to GT2105-Q.
Reads tag files created with OMRON programming 
software.

[RSLogix 5000Tag]
Not available to GT2105-Q.
Reads tag files created with ALLEN-BRADLEY 
programming software.

[AB Native Tag] Reads tag files created with ALLEN-BRADLEY 
programming software.

[OPC UA Tag] Reads tag information files exported from GT OPC 
UA Client.

[Profile (CSP+)] [Label (GT Designer3) 
Auto Registration]

Registers the labels (GT Designer3) created from 
profile data automatically.

[Save As Single File Format Project]
Saves the project in the single file format (*.GTX).
To be displayed only when GT Designer3 is started 
from MELSOFT Navigator.

[Save Package Data] Saves the project in the single file format (*.GTXS).

[Security]

[Security Key Setting] Assign a security key to the project or the GOT.

[Security Key Management] Manage security keys.

[User Management] Manage the user information registered with the 
project.

[Setup Access Authority] Set the access authority of each access level.

[Change Password] Change the password of the logged-in user.

[Page Settings] Adjusts the page layout for printing.

[Print Preview] Displays a print preview.

[Print] Prints out the contents of the settings of the project 
or outputs them into a file.

[Recent Projects] Lists up to five recently-used projects.

Menu Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■2 [Edit]

[Start GT Designer3 (GOT1000)] Starts GT Designer3 (GOT1000).

[Exit] Exits GT Designer3.

Menu Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Undo] Cancels the immediately preceding operation.

[Redo] Redoes the operation canceled by [Undo].

[Cut] Cuts a selected target.

[Copy] Copies a selected target.

[Paste] Pastes a copied or cut target to a selected area.

[Duplicate] Pastes a copy of a figure or object selected on the 
screen editor.

[Consecutive Copy] Pastes multiple copies of a figure or object selected 
on the screen editor.

[Select All] Selects all figures and objects arranged on the 
screen editor.

[Delete] Deletes a selected target.

[Object of Selection]

[Figure]

Changes the target for selecting on the screen 
editor.

[Object]

[Figure + Object]

[Report Line]

[Overlay Screen] Switches between setting and canceling set overlay 
screens as the targets for selecting.

[Group] Groups selected figures and objects.

[Ungroup] Cancels the grouping of a selected group.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Stacking Order]

[Move to the Front of Front Layer]

Changes the order of the layers of selected figures 
and objects.

[Move to the Back of Back Layer]

[Move to the Front of Layer]

[Move to the Back of Layer]

[Move to the Foreground]

[Move to the Background]

[Move to the Front]

[Move to the Back]

[Align]

[Left]

Aligns the positions of selected figures and objects.

[Center (Horizontal)]

[Right]

[Top]

[Center (Vertical)]

[Bottom]

[Align Sideways]

[Align Lengthways]

[Custom]

[Rotate/Flip]

[Flip Vertical]

Rotates or flips a selected figure.
[Flip Horizontal]

[Rotate Left]

[Rotate Right]

[Edit Vertex] Switches between changing and fixing the positions 
of the vertexes of a figure.

[Edit Objects with Fixed 
Frame Width]

[Always Fix the Width] Fixes or does not fix the frame width of the object 
shape when the object is resized.

[Collective Edit]
Changes the shape frame widths of all objects that 
satisfy the frame width fixing conditions. 
After the change, the frame widths become fixed.

[Edit Touch Area]

[Edit Manually]
Switches between separately setting and 
simultaneously setting the touch area and the 
displayed area of a touch switch.

[Adjust Automatically] Matches the touch area of a selected touch switch 
with the displayed area.

[Always Adjust Automatically]
Switches between automatically matching and 
leaving unmatched the touch area of a touch switch 
with the displayed area.

[Adjust Direct Text Size] Switches between changing and fixing text size by 
scaling the object size.

[Template Registration]
[Register to Template] Registers a selected figure or object as a template.

[Deregister from Template] Deletes a selected figure or object from the template 
list.

[Edit Template Attribute] Edits the template attribute of a selected template.

[Set as Default] Changes the settings of a selected figure or an 
object to the default values.

[Add to Category]

[Switch]

Changes the category of a selected figure or an 
object.

[Lamp]

[Other]

[User Definition Category]

Menu Description Supported 
models
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■3 [Search/Replace]

[Shape Change] Changes the shape of a selected object.

[Display Template Property] Displays the settings of a selected template.

[Open Setting Dialog] Displays the setting dialog of a selected figure or an 
object.

Menu Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Device Search] Search the project for matching devices, labels, or 
tags.

[Device List]

[Screen]

Displays the list of the devices used in the project.[Project]

[Script Text]

[Text List] Displays the list of the texts used in the project.

[Batch Edit]

[Device] Changes the device settings in the project 
collectively.

[Unit No./Axis No.] Changes the unit numbers and axis numbers in the 
project collectively.

[Network] Changes the network settings in the project 
collectively.

[CH No.] Changes the channel number settings in the project 
collectively.

[Color] Changes the color settings in the project collectively.

[Figure] Changes the shape settings in the project 
collectively.

[Data Browser] Displays the [Data Browser] window.

[IP Address List] Displays the [IP Address List] window.

GT27 GT25 GT23

SoftGOT2000
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■4 [View]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Preview] Displays the preview of the project being edited.

[Window Preview]

[Apply to All Base Screens]
Switches between applying settings in the [Window 
Preview] dialog to all base screens and configuring 
the settings for each base screen.

[Apply to all mobile screens]
Switches between applying settings in the [Window 
Preview] dialog to all mobile screens and 
configuring the settings for each mobile screen.

[Overlap Window1] Displays the preview of overlap window 1.

[Overlap Window2] Displays the preview of overlap window 2.

[Overlap Window3] Displays the preview of overlap window 3.

[Overlap Window4] Displays the preview of overlap window 4.

[Overlap Window5] Displays the preview of overlap window 5.

[Superimpose 1] Displays the preview of superimpose window 1.

[Superimpose 2] Displays the preview of superimpose window 2.

[Key Window] Displays the preview of the key window.

[Dialog Window] Displays the preview of the dialog window.

[PC Remote Operation]
Displays the preview of the remote screen of the 
remote personal computer operation function 
(Ethernet).

[Setting] Sets a window screen to be displayed.

[ON/OFF Display Switching] Switches the display status of objects on screen 
editors between ON and OFF.

[State No.]
[Previous State] Switches the states of objects to be displayed on 

screen editors in descending order.

[Next State] Switches the states of objects to be displayed on 
screen editors in ascending order.

[Refresh] Redisplays a selected screen editor.
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[Toolbar]

[Standard] Switches between displaying and hiding the 
[Standard] toolbar.

[Window Display] Switches between displaying and hiding the 
[Window Display] toolbar.

[Display] Switches between displaying and hiding the 
[Display] toolbar.

[Screen] Switches between displaying and hiding the 
[Screen] toolbar.

[Edit] Switches between displaying and hiding the [Edit] 
toolbar.

[Figure] Switches between displaying and hiding the [Figure] 
toolbar.

[Object] Switches between displaying and hiding the [Object] 
toolbar.

[Align] Switches between displaying and hiding the [Align] 
toolbar.

[Draw Figure] Switches between displaying and hiding the [Draw 
Figure] toolbar.

[Communication] Switches between displaying and hiding the 
[Communication] toolbar.

[Diagnostics] Displays or hides the [Diagnostics] toolbar.

[Simulator] Switches between displaying and hiding the 
[Simulator] toolbar.

[GOT Offline Monitor] Switches between displaying and hiding the [GOT 
Offline Monitor] toolbar.

[Report] Switches between displaying and hiding the [Report] 
toolbar.

[Coordinate/Size] Switches between displaying and hiding the 
[Coordinate/Size] toolbar.

[My Favorites] Switches between displaying and hiding the [My 
Favorites] toolbar.

[Customize]
Customizes the toolbar.
➟11.10.1 Customizing the toolbar

Menu Description Supported 
models
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[Docking Window]

[Project Tree] Switches between displaying and hiding the 
[Project] window.

[Screen Tree] Switches between displaying and hiding the 
[Screen] window.

[System Tree] Switches between displaying and hiding the 
[System] window.

[Device Search] Displays or hides the [Device Search] window.

[Data Browser] Displays the [Data Browser] window.

[Propertysheet] Switches between displaying and hiding the 
[Property] window.

[IP Address List] Switches between displaying and hiding the [IP 
Address List] window.

[Library List] Displays the [Library] window.

[Library List (Template)] Displays the [Library] window with displaying the 
template screen in tree view.

[Controller Type List] Switches between displaying and hiding the 
[Controller Type List] window.

[Data View] Switches between displaying and hiding the [Data 
View] window.

[Screen Image List] Switches between displaying and hiding the [Screen 
Image List] window.

[Category List] Switches between displaying and hiding the 
[Category List] window.

[Parts Image List] Switches between displaying and hiding the [Parts 
Image List] window.

[Utilize (Screen)] Displays the [Utilize (Screen)] window.

[Data Check List] Displays the [Data Check List] window.

[Output] Displays the [Output] window.

[Verify Result] Displays the [Verify Result] window.

[Editor Tab] Switches between displaying and hiding the editor 
tab.

[Status bar] Switches between displaying and hiding the status 
bar.

[Display Items]

[Device] Switches between displaying and hiding devices on 
screen editors.

[Device of Label]
Displays or hides the devices that are assigned to 
system labels and labels (GT Designer3) on screen 
editors.

[Object ID] Switches between displaying and hiding object IDs 
on screen editors.

[Paint] Switches between displaying and hiding paints on 
screen editors.

[Object] Switches between displaying and hiding objects on 
screen editors.

[Object Frame] Switches between displaying and hiding object 
frames on screen editors.

[Template Information] Switches between displaying and hiding template 
information on screen editors.

[Touch Area] Switches between displaying and hiding the touch 
areas of touch switches on screen editors.

[Frame] Switches between displaying and hiding the frames 
of screen editors.

[Option] Displays the [Display] tab in the [Option] dialog to set 
information to be displayed on screen editors.

[Grid]

[Front]

Displays the grids of screen editors.[Back]

[None]

Menu Description Supported 
models
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[Two-point Press Inactive 
Area]

[Front]

Displays the two-point press inactive area on the 
screen editor.

[Back]

[None]

[Scroll Bar Area]

[Front]

Displays the scroll bar areas on the screen editor for 
editing the expanded base screens.

[Back]

[None]

[Display with Layer]

[All screens]

Sets layers to be displayed.
[Front]

[Back]

[Front and Back]

[Guidelines (auxiliary line)]

[Display]

Sets guidelines to be displayed for placing a figure 
or object.

[Figure]

[Object]

[Figure and Object]

[Same Type]

[Custom]

[Zoom]

[All Screens]
Switches between applying a magnification setting 
to all screen editors and configuring the setting for 
each screen editor.

[400%]

Changes the magnification of screen editors.

[300%]

[200%]

[150%]

[100%]

[75%]

[50%]

[25%]

[Custom]

[Whole Screen]

[Switch Display Language] Switches the display language of GT Designer3.

Menu Description Supported 
models
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■5 [Screen]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[New]

[Base Screen] Create a base screen.

[Window Screen] Create a window screen.

[Report Screen] Create a report screen.

[Mobile Screen] Create a mobile screen.

[Dialog Window Wizard] Create a window screen for a dialog window.

[Utilize Data] Search other projects for screens that can be 
utilized.

[Open] Open a selected window.

[Close] Closes a window being edited.

[Close All] Closes all windows.

[Copy] Copy a selected window.

[Delete] Delete a selected window.

[Screen Design] Displays the [Screen Design] dialog.

[Screen Image List] Displays the [Screen Image List] window.

[Previous Screen] Opens a screen whose screen number is one 
smaller than that of the screen being edited.

[Next Screen] Opens a screen whose screen number is one 
greater than that of the screen being edited.

[Open Closed Screens] Sets or cancels a closed screen as the target for the 
operation of [Previous Screen] or [Next Screen].

[Screen Script] Set screen scripts.

[Screen Trigger Action] Set screen trigger actions.

[Resize Screen]

Resizes the following screens.
• Base screen (when the base screen size 

expansion is enabled)
• Window screen
• Mobile screen

[Copy Screen Image to the Clipboard] Captures a screen editor being edited.

[Report Setting] Configure the settings for the report function.

[Header/Footer/Repeat] Set the header, footer, and repeat row.

[Screen Property] Configure the settings for the screen being edited.
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■6 [Common]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[GOT Type Setting] Change the GOT model setting of the project.

[GOT Environmental 
Setting]

[Screen Switching/Window] Configure the settings of screen switching.

[Language Switching] Configure the settings of language switching.

[Dialog Window] Configure the settings of the system message dialog 
window.

[Key Window] Configure the settings of key windows in the project.

[System Information] Set devices that handle the system information.

[Security] Set a password for operating the GOT and reading 
the data from the GOT.

[Operation Log]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings for collecting operation 
history events of the GOT.

[Internal Device Retention]
Not available to GT2103-P.
Configure the settings for retaining GOT internal 
device values.

[Kana-Kanji/Pinyin Conversion]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings of kana-kanji conversion or 
Pinyin conversion on the GOT.

[Startup Logo] Set the initial screen displayed at the GOT startup.

[GOT Setup] [Basic Setting]

[Display Setting/Language 
Setting] Configure the display settings of the GOT.

[GOT ID No.] Set unique information to the GOT.

[Operation Setting/Utility 
Call Key]

Set a buzzer sound and the utility call key for the 
GOT.

[USB Host]

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.
Configure the settings for using a mouse and 
keyboard on the GOT.

[Time Setting] Set the GOT time setting method.

[Transparent Mode 
Setting]

Set the target channel for the FA transparent 
function.

[GOT Internal Device 
Monitor]

Set whether to use the GOT internal device monitor 
of the GOT diagnostics function.
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[GOT Setup] [Advanced Setting]

[SoftGOT-GOT Link] Configure the settings for the SoftGOT-GOT link 
function.

[VNC Server]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings for the VNC server function.

[Sequence Program 
Monitor]

Configure the settings for the sequence program 
monitor.

[Backup/Restoration] Configure the settings for the backup/restoration 
function.

[Wireless LAN Setting]
Not available to GT2505-V and GT25HS-V.
Configure the wireless LAN settings.

[System Launcher] Configure the system launcher settings.

[iQSS Utility] Configure the iQSS utility settings.

[Network Drive] Configure the network drive settings.

[GOT Ethernet Setting]

[GOT IP Address Setting]
Not available to GT2105-Q.
Set the IP address of the GOT.

[GOT Ethernet Common Setting]
Not available to GT2105-Q.
Configure the GOT Ethernet setting.

[IP filter Setting]
Not available to GT2105-Q.
Configure the IP filter setting.

[Controller Setting] Configure the settings for communicating with 
controllers.

Menu Description Supported 
models
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[Peripheral Setting]

[PC (Data Transfer)] Set the interface for connecting GT Designer3 
(personal computer) with the GOT.

[Bar Code]
Not available to GT25HS-V.
Configure the settings for using a barcode reader on 
the GOT.

[RFID]
Not available to GT25HS-V.
Configure the settings for using a RFID controller on 
the GOT.

[PC Remote Operation] Configure the settings for operating the personal 
computer from the GOT.

[VNC Server]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings for viewing the GOT display 
contents from the personal computer.

[Video/RGB Input]
Not available to GT2705-V.
Configure the settings for displaying the video data 
taken with a video camera on the GOT.

[Multimedia]
Not available to GT2705-V.
Configure the settings for recording or playing the 
video data taken with a video camera on the GOT.

[External I/O / Operation Panel]

Not available to GT25-W, GT2505-V, and GT25HS-
V.
Configure the settings for using an external I/O 
device and operation panel with the GOT.

[HDMI/RGB Output]
Not available to GT2705-V.
Configure the settings for outputting the GOT screen 
data to an external display.

[Printer] Configure the settings for using a printer on the 
GOT.

[Sound Output]
Not available to GT2505-V and GT25HS-V.
Configure the setting for outputting sounds from the 
GOT.

[GOT (Extended Computer)] Set the interface for the connection to the GOT 
(Extended Computer).

[GOT Network Interaction]
Configure the settings for controlling pieces of 
equipment on the same network to prevent 
simultaneous operations.

[GOT Mobile Setting] Configure the settings for using the GOT as the 
server in the GOT Mobile function.

Menu Description Supported 
models
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[I/F Communication Setting] Lists the interface settings of the GOT.

[Label]

[Open] Lists label groups.

[New Label Group] Create a label group.

[Label Group Property] Change the number and title of a label group.

[Comment]

[Open] Lists comment groups.

[New Comment Group] Create a comment group.

[Comment Group Property] Change the number and title of a comment group.

[New Row] Create a row at the bottom of the comment group 
being edited.

[Insert Row] Insert a new row into a comment group being edited.

[Insert Column] Insert a new column into a comment group being 
edited.

[Import] Imports a comment group from a file.

[Export] Outputs a comment group to a file.

[Search] Searches a comment in a comment group.

[Jump] Displays the row of a specified comment No.

[Attribute Setting] Changes the attribute of a selected row.

[Attribute Display/Non-Display] Switches between displaying and hiding the 
attribute of a comment group.

[Alarm]

[Alarm Common Setting] Sets devices which convert alarm files.

[User Alarm Observation] Configures the settings for collecting alarms by 
monitoring target devices.

[System Alarm Observation] Configures the settings for collecting alarms by 
monitoring the system.

[Alarm Popup Display]
Configures the setting for displaying collected 
alarms in a popup window when the alarms are 
collected.

[Logging] Configures the settings for collecting device values.

[Recipe]
[Recipe Common Setting] Sets devices for control used by the recipe function.

[Recipe] Configures the settings for executing batch write or 
batch read on multiple devices.

[Script]

[Script] Sets scripts.

[Script List] Displays the list of scripts.

[Script Symbol] Sets script symbols.

[Object Script Symbol] Sets object script symbols.

[Device Data Transfer] Configures the settings for transferring data 
between devices.

[Trigger Action] Sets actions with the devices or sampling cycle that 
trigger the actions.

[Time Action] Sets actions with time that triggers the actions.

[Hard Copy] Captures the operating screen of the GOT.

Menu Description Supported 
models
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[MES Interface] Configures the settings for sending SQL statements 
from the GOT to the personal computer database.

[Application in Use Setup] Sets a system application to be written to the GOT.

[Parts]

[Parts Image List] Displays the list of part images.

[Parts Setting] Configures the part settings.

[New] Creates a new part.

[Sound]

[Sound Files]
Not available to GT2505-V and GT25HS-V.
Lists the sound files to register or edit the files.

[Touch Key Sound Setting]
Not available to GT2505-V and GT25HS-V.
Configure the setting to use a specified sound file for 
the touch key sound.

Menu Description Supported 
models
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■7 [Figure]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Text] Draws a text.

[Logo Text] Draws a logo text.

[Line] Draws a line.

[Line Freeform] Draws a freeform line.

[Rectangle] Draws a rectangle.

[Polygon] Draws a polygon.

[Circle] Draws a circle.

[Arc] Draws an arc.

[Sector] Draws a sector.

[Table] Draws a table.

[Scale] Draws a scale.

[Piping] Draws a piping.

[Paint] Fills the framed area of the figure on the screen.

[Import Image Data] Imports an image file into the screen.

[Import DXF Data] Imports a DXF data into the screen.

[Import IGES Data] Imports an IGES data into the screen.
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■8 [Object]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Select Library]

[Library List] Displays the [Library] window.

[System Library] Displays the [Library] window with data of [System 
Library] shown in the tree view.

[My Favorites] Displays the [Library] window with data of [My 
Favorites] shown in the tree view.

[Switch]

[Switch] Place a touch switch with multiple functions.

[Bit Switch] Place a touch switch to switch ON/OFF of a bit 
device.

[Word Switch] Place a touch switch to change the value of a word 
device.

[Go To Screen Switch] Place a touch switch to switch a screen.

[Change Station No. Switch] Place a touch switch to switch the station number of 
the GOT monitoring target.

[Special Function Switch] Place a touch switch to display the utility or the 
screen for a monitor function.

[Key Window Display Switch] Place a touch switch to display a key window.

[Key Code Switch] Place a touch switch to enter a key code.

[Lamp]

[Bit Lamp] Place a lamp controlled by a bit device.

[Word Lamp] Place a lamp controlled by a word device.

[Lamp Area] Place a lamp area object controlled by a bit device.

[Numerical Display/Input]

[Numerical Display] Place an object to display a device value (numerical 
value).

[Numerical Input] Place an object to input a device value (numerical 
value).

[Text Display/Input]
[Text Display] Place an object to display a device value (text).

[Text Input] Place an object to input a device value (text).

[Date/Time Display]
[Date Display] Place an object to display the date.

[Time Display] Place an object to display the time.

[Comment Display]

[Bit Comment] Place an object to display a comment. A bit device 
controls the displayed comment.

[Word Comment] Place an object to display a comment. A word device 
controls the displayed comment.

[Simple Comment] Place an object to display a comment. The displayed 
comment is fixed.

[Parts Display]

[Bit Parts] Place an object to display parts. A bit device controls 
the displayed parts.

[Word Parts] Place an object to display parts. A word device 
controls the displayed parts.

[Fixed Parts] Place an object to display parts. The displayed parts 
are fixed.

[Parts Movement]

[Bit Parts] Place an object to move parts. A bit device controls 
the displayed parts.

[Word Parts] Place an object to move parts. A word device 
controls the displayed parts.

[Fixed Parts] Place an object to move parts. The displayed parts 
are fixed.

[Parts Move Route] Set a route to move parts.

[Historical Data List Display] Place an object to display the history of device 
values collected by the logging function.
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[Alarm Display]

[Alarm Display (User)] Place an object to display the alarms collected by 
the user alarm observation.

[Alarm Display (System)] Place an object to display the alarms collected by 
the system alarm observation.

[Simple Alarm Display]
Place an object to display the alarms collected by 
monitoring devices. Set the alarms to be monitored 
by object.

[System Alarm Display]
Place an object to display the alarms collected by 
monitoring the system. Set the alarms to be 
monitored by object.

[Recipe Display (Record List)]
Place an object to list the records of a recipe.
This object must be used in combination with the 
recipe function.

[Graph]

[Line Graph] Place an object to display device values in line 
graph.

[Trend Graph] Place an object to display device values in 
chronological order in graph.

[Bar Graph] Place an object to display device values in bar 
graph.

[Statistics Bar Graph] Place an object to display the ratio of each device 
value to the total device values in bar graph.

[Statistics Pie Graph] Place an object to display the ratio of each device 
value to the total device values in pie graph.

[Scatter Graph]
Place an object to display two device values as a 
point in scatter graph by assigning the two devices 
to the X and Y coordinates respectively.

[Historical Trend Graph]
Place an object to display the device values 
collected by the logging function in chronological 
order in graph.

[Graphical Meter]

[Sector Meter] Place an object to display a device value on a sector 
meter.

[Semicircle Meter] Place an object to display a device value on a 
semicircle meter.

[Bar (Vertical) Meter] Place an object to display a device value on a 
vertical bar meter.

[Bar (Horizontal) Meter] Place an object to display a device value on a 
horizontal bar meter.

[Meter]

[Level] Place an object to display a device value by filling 
the specified area.

[Panelmeter] Place an object to display a device value on a meter.

[Slider] Place an object to specify a device value (numeric 
value) by sliding the knob along the bar.

Menu Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Document Display] Place an object to display a document on a screen.

[Video/RGB display]
Not available to GT2705-V. Place an object to 
display an RGB image. Displaying video images will 
be supported soon.

[Script Parts] Place an object to create a script.

[Set Overlay Screen] Place an object to overlay a called screen on a base 
screen.

[Window Position]

[Overlap1] Place an object to specify the display position of 
overlap window 1.

[Overlap2] Place an object to specify the display position of 
overlap window 2.

[Overlap3] Place an object to specify the display position of 
overlap window 3.

[Overlap4] Place an object to specify the display position of 
overlap window 4.

[Overlap5] Place an object to specify the display position of 
overlap window 5.

[Superimpose1] Place an object to specify the display position of 
superimpose window 1.

[Superimpose2] Place an object to specify the display position of 
superimpose window 2.

[Key Window] Place an object to specify the display position of the 
key window.

[Key Window Object]

[Input Value Area Setting] Place an object to display the value being input.

[Input Range Area Setting] Place an object to display the range of values that 
can be input.

[Input Maximum Value Area Setting] Place an object to display the maximum value that 
can be input.

[Input Minimum Value Area Setting] Place an object to display the minimum value that 
can be input.

[Previous Value Area Setting] Place an object to display the value that is input 
previously.

[Project Setting] Configure the settings of key windows in the project.

[Print]

[Numerical Print] Place an object to print a device value (numerical 
value).

[Text Print] Place an object to print a device value (text).

[Bit Comment Print] Place an object to print a comment. A bit device 
controls the comment to be printed.

[Word Comment Print] Place an object to print a comment. A word device 
controls the comment to be printed.

[Hyperlink] Place an object to access a website or a file in the 
GOT public folder, or make a phone call.

[My Favorites] Displays objects registered in [My Favorites] in the 
library.

Menu Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■9 [Communication]

■10 [Diagnostics]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Write to GOT] Writes data from the personal computer (GT 
Designer3) to the GOT.

[Read from GOT] Reads data from the GOT to the personal computer 
(GT Designer3).

[Verify GOT] Compares the project being edited with the project in 
the GOT.

[Communication Configuration] Sets the method of the communication between the 
personal computer (GT Designer3) and the GOT.

[Batch Write to multiple GOTs]
Not available to GT2105-Q.
Writes data to multiple GOTs in one go with a 
personal computer (GT Designer3).

[Write to Memory Card] Writes data to data storage.

[CSP+ for iQSS Data Write] Writes iQSS data (CSP+) to a data storage.

[Communicate with GT01-RS4-M] Transfers data between the personal computer (GT 
Designer3) and GT01-RS4-M.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[GOT Diagnostics] Displays the GOT error information.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■11 [Tools]
GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Data Check]

[Check] Checks if no error exists in the project.

[Item Setting] Sets the targets for the data check function.

[System Label Update/
Check]

[Update/Check] Updates system labels and checks them.

[Setting] Configures the settings of iQ Works interaction.

[Label Check] Updates labels (GT Designer3) and checks them.

[Data Size]

[Screen]

Displays the data size of the screen and the project.
[Project]

[Simulator]

[Activate]

Simulates the project you are editing.
[Update]

[Setting]

[Exit]

[GOT Offline Monitor]

[Activate]
Monitors the project running on the GOT by 
establishing connection with the GX Works3 offline 
monitor on a personal computer.

[Set]

[Exit]

[Resource Data 
Conversion]

[Operation Log File]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Converts the file format of the operation log file.

[Alarm File] Converts the file format of the alarm file.

[Logging File] Converts the file format of the logging file.

[Recipe File] Converts the file format of the recipe file.

[Default Setting]

[Edit]

Sets the preset values of figures and objects.[Export]

[Import]

[Customize]
Customizes the toolbar.
➟11.10.1 Customizing the toolbar

[Option] Customizes operations and displayed contents of 
GT Designer3.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■12 [Window]

■13 [Help]

(1) [About GT Designer3] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[Cascade]
Aligns screen editors and windows on the work 
window.[Vertical]

[Horizontal]

[Align Icons] Aligns minimized screens.

[Close All Windows] Closes all screens on the work window.

List of windows being opened Up to nine screens being opened on the work 
window are displayed in the pull-down menu.

[Other Windows] Select a screen to be operated on the [Window 
Selection] dialog.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Supported 
models

[GT Designer3 Help] Displays Help.

[Manual List] Lists the manuals.

[Connection to MITSUBISHI ELECTRIC FA Global Website] Connects to the MITSUBISHI ELECTRIC FA Global 
Website.

[About GT Designer3]
Displays the version of GT Designer3.
➟(1) [About GT Designer3] dialog

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Version of GT Designer3

1.225K

Major version

Minor version
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2.2.2 Toolbar and shortcut keys

➟■1 [Main]
■2 [Window Display]
■3 [View]
■4 [Screen]
■5 [Edit]
■6 [Figure]
■7 [Object]
■8 [Align]
■9 [Draw Figure]
■10 [Communication]
■11 [Diagnostics]
■12 [Simulator]
■13 [GOT Offline Monitor]
■14 [Report]
■15 [Coordinate/Size]
■16 [My Favorites]

• You can switch between displaying and hiding the toolbar items of GT Designer3 with the [Display] menu.

• Some buttons may not be displayed on the toolbar.
Select the hidden buttons from the toolbar to display them on the pull-down menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Indicates whether each toolbar 
is displayed or hidden.

: Displays the toolbar.

Displays hidden switches.

Displays a selected button on the toolbar. 

Example) When the [Word Switch] button is selected
2. CREATING A PROJECT
2.2 Screen Layout of GT Designer3
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• You can check shortcut keys on each pull-down menu.

■1 [Main]

1) [New] button
Creates a new project.
Shortcut key: [Ctrl] + [N]

2) [Open] button
Opens a saved project.
Shortcut key: [Ctrl] + [O]

3) [Save] button
Overwrites the project being edited.
Shortcut key: [Ctrl] + [S]

4) [Cut] button
Cuts a selected target.
Shortcut key: [Ctrl] + [X]

5) [Copy] button
Copies a selected target.
Shortcut key: [Ctrl] + [C]

6) [Paste] button
Pastes a copied or cut target to a selected area.
Shortcut key: [Ctrl] + [V]

7) [Undo] button
Cancels the last operation.
Shortcut key: [Ctrl] + [Z]

8) [Redo] button
Redoes the operation canceled by [Undo].
Shortcut key: [Ctrl] + [Y]

9) [Figure or Object Selection] button
Enables the mouse cursor to select a figure and object.

10) [GT Designer3 Help] button
Displays GT Designer3 Help.
Shortcut key: [F1]

Shortcut key

Item Description

[Utilize] Searches projects that can be utilized.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4) 5) 6) 7) 8) 9) 10)
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■2 [Window Display]

1) [Docking Window: Project Tree] button
Displays or hides the [Project] window.
Shortcut key: [Alt] + [0]

2) [Docking Window: Screen Tree] button
Displays or hides the [Screen] window.

3) [Docking Window: System Tree] button
Displays or hides the [System] window.

4) [Docking Window: Data Browser] button
Displays or hides the [Data Browser] window.
Shortcut key: [Ctrl] + [E]

5) [Docking Window: Property Sheet] button
Displays or hides the [Property] window.
Shortcut key: [Alt] + [1]

6) [Docking Window: IP Address List] button
Displays or hides the [IP Address List] window.

7) [Docking Window: Library List] button
Displays or hides the [Library] window.
Shortcut key: [F9]

8) [Docking Window: Library List (Template)] button
Displays the [Library] window with displaying the template screen in tree view.
Shortcut key: [Alt] + [F9]

9) [Docking Window: Data View] button
Displays or hides the [Data View] window.

10) [Docking Window: Utilize Creation (Screen)] button
Displays or hides the [Utilize Creation (Screen)] window.

11) [Docking Window: Data Check List] button
Displays or hides the [Data Check List] window.

12) [Docking Window: Output] button
Displays or hides the [Output] window.

13) [Docking Window: Verify Result] button
Displays or hides the [Verify Result] window.

14) [GOT Type Setting] button
Displays the [GOT Type Setting] dialog.

15) [GOT Environmental Setting: Screen Switching/Window] button
Displays the [Environmental Setting] window.

16) [GOT Setup: Basic Setting: Display Setting/Language Setting] button
Displays the [GOT Setup] window.

17) [GOT Ethernet Setting] button
Displays the [GOT Ethernet Setting] window.

18) [Controller Setting] button
Displays the [Controller Setting] window.

19) [Label: Open] button
Displays the [Label Group List] dialog.

20) [Comment: Open] button
Displays the [Open Comment Group] dialog.

21) [Docking Window: Device Search] button
Displays or hides the [Device Search] window.
Shortcut key: [Ctrl] + [F]

22) [Device List: Screen] button

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4) 5) 6) 7) 8) 9) 10) 11) 12) 13) 14) 15) 16) 17) 18) 19) 20) 21) 22) 23)
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Displays the [Device List] window.
23) [Text List] button

Displays the [Text List] window.

■3 [View]

1) [Snap]
Sets the moving distance of a figure and an object on the screen editor.

2) [Zoom]
Sets the magnification of the screen editor.

3) [Expansion] button
Increases the magnification of the screen editor in increments of 10%.
Shortcut key: [Ctrl] + [Num+]

4) [Reduction] button
Reduces the magnification of the screen editor in decrements of 10%.
Shortcut key: [Ctrl] + [Num-]

5) [Whole Screen] button
Resizes the screen display area of the screen editor according to the editor window size.
This item is unavailable when [All Screens] is selected in [Zoom] on the [View] menu.

6) [Grid Interval]
Sets the distance between the lines of the grid on the screen editor.

7) [Grid Color]
Sets the grid color of the screen editor.

8) [ON] button, [OFF] button
Switches the display status of objects on screen editors between ON and OFF.
Shortcut key: [F7] (The display of devices can be off by [F8] as well.)

9) [Previous State] button
Switches the states of objects to be displayed on screen editors in descending order.

10) [Next State] button
Switches the states of objects to be displayed on screen editors in ascending order.

11) [State No.]
Switches the states of objects to be displayed on screen editors by selecting the state No.

12) [Display Items: Device] button
Switches between displaying and hiding devices on screen editors.

13) [Display Items: Device of Label] button
Displays or hides the devices that are assigned to system labels and labels (GT Designer3) on screen editors.

14) [Display Items: Object ID] button
Switches between displaying and hiding object IDs on screen editors.

15) [Layer Display: Front] button, [Layer Display: Back] button, [Layer Display: Front+Back] button
Switches layers to be displayed.
Not available to GT21 and GS21.

16) [Language Switching Preview Column No.]
Sets a comment column No. to be displayed on the screen editor.
The setting range is [1] to [30].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4) 6)5) 7) 8) 13) 14) 15) 16)12)10) 11)9)
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■4 [Screen]

1) [New] button
Creates a new screen.

2) [Open] button
Opens a selected window.

3) [Screen Image List] button
Displays the [Screen Image List] window.

4) [Previous Screen] button
Opens a screen whose screen number is one smaller than that of a screen being edited.
Shortcut key: [Ctrl] + [Alt] + [P]

5) [Next Screen] button
Opens a screen whose screen number is one greater than that of a screen being edited.
Shortcut key: [Ctrl] + [Alt] + [N]

6) [Open Closed Screens] button
Switches between setting and canceling screens that are closed as the target for the operation of [Previous Screen] 
or [Next Screen].

7) [Screen Background Color] button

Select a background color, gradient, and pattern for the screen.

Select a background color for the screen.
8) [Screen Color Pattern] button

Select a pattern for the screen background.
9) [Screen Color Pattern Color] button

Select a pattern color for the screen background.
10) [Preview] button

Displays the preview of the screen being edited.
Shortcut key: [Ctrl] + [I]

Item Description

[Base Screen] Creates a new base screen.

[Window Screen] Create a new window screen.

[Report Screen] Creates a new report screen.

[Mobile Screen]
Creates a mobile screen.
Available to GT27, GT25, GT SoftGOT2000, and GS25.

[Dialog Window Wizard] Creates a window screen for a dialog window.

[Utilize] Searches a screen of another project which can be utilized.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

7) 10)1) 2) 3) 4) 5) 6) 7)8) 9)

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.1

GOT Graphic Ver.1
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■5 [Edit]

1) [Stacking Order: Moves to front] button
Moves selected figures and objects to the front.

2) [Stacking Order: Moves to back] button
Moves selected figures and objects to the back.

3) [Group] button
Groups selected figures and objects.
Shortcut key: [Ctrl] + [G]

4) [Ungroup] button
Cancels the grouping of selected figures and objects.
Shortcut key: [Ctrl] + [U]

5) [Template Registration: Register to Template] button
Registers a selected figure or object to the template.

6) [Template Registration: Register from Template] button
Deletes a selected figure or object from the template list.

7) [Edit Template Attribute] button
Edits the template attribute of selected template information.

8) [Turn/Invert: Flip Horizontal] button
Flips a selected figure horizontally.
Shortcut key: [Ctrl] + [H]

9) [Turn/Invert: Flip Vertical] button
Flips a selected figure vertically.
Shortcut key: [Ctrl] + [J]

10) [Turn/Invert: Rotate Left] button
Rotates a selected figure 90 degrees counterclockwise.
Shortcut key: [Ctrl] + [L]

11) [Turn/Invert: Rotate Right] button
Rotates a selected figure 90 decrees clockwise.
Shortcut key: [Ctrl] + [R]

12) [Edit Vertex] button
Changes the length of a freeform line or a polygon line.

13) [Align: Custom] button
Aligns selected figures and objects.

14) [Object of Selection: Shape] button
Sets only figures as the targets for selecting.

15) [Object of Selection: Object] button
Sets only objects as the targets for selecting.

16) [Object of Selection: Shape + Object] button
Sets figures and objects as the targets for selecting.

17) [Object of Selection: Overlay Screen] button
Switches between setting and canceling set overlay screens as the targets for selecting.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3) 4) 5) 6) 7) 8) 9) 10) 11) 12) 13) 14) 15) 16) 17)2)
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■6 [Figure]

1) [Text] button
Draws a text.

2) [Logo Text] button
Draws a logo text.

3) [Line] button
Draws a line.

4) [Line Freeform] button
Draws a freeform line.

5) [Rectangle] button
Draws a rectangle.

6) [Polygon] button
Draws a polygon.

7) [Circle] button
Draws a circle.

8) [Arc] button
Draws an arc.

9) [Sector] button
Draws a sector.

10) [Table] button
Draws a table.

11) [Scale] button
Draws a scale.

12) [Piping] button
Draws a piping.

13) [Paint] button

Fills the framed area of the figure on the screen.
14) [Import Image Data] button

Imports an image file into the screen.
15) [Import DXF Data] button

Imports a DXF data into the screen.
16) [Import IGES Data] button

Imports an IGES data into the screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3) 4) 5) 6) 7) 8) 9) 10) 11) 12) 13) 14) 15) 16)2)

GOT Graphic Ver.1
2. CREATING A PROJECT
2.2 Screen Layout of GT Designer3

2 - 35



■7 [Object]

1) [Switch] button

2) [Lamp] button

3) [Numerical Display/Input] button

4) [ASCII Display/Input] button

5) [Date/Time Display] button

6) [Comment Display] button

7) [Parts Display] button

Item Description

[Switch] button Touch switch with multiple functions

[Bit Switch] button Touch switch to switch ON/OFF of a bit device

[Word Switch] button Touch switch to change the value of a word device

[Go To Screen Switch] button Touch switch to switch the screen

[Change Station No. Switch] button Touch switch to switch the station No. of the GOT monitor target

[Special Function Switch] button Touch switch to display the utility or the screen for the monitor function

[Key Window Display Switch] button Touch switch to display a key window

[Key Code Switch] button Touch switch to enter a key code

Item Description

[Bit Lamp] Lamp controlled by the bit device

[Word Lamp] Lamp controlled by the word device

[Lamp Area] Lamp area controlled by the bit device

Item Description

[Numerical Display] Object to display a device value (numeric value)

[Numerical Input] Object to input the device value (numeric value)

Item Description

[ASCII Display] Object to display the device value (text)

[ASCII Input] Object to input the device value (text).

Item Description

[Date Display] Object to display the date

[Time Display] Object to display the time

Item Description

[Bit Comment] Object to display the comments The bit device controls the displayed comments.

Word comment Object to display the comments The word device controls the displayed comments.

[Simple Comment] Object to display the comments The displayed comments are fixed.

Item Description

[Bit Parts] Object to display the parts The bit device controls the displayed parts.

[Word Parts] Object to display the parts The word device controls the displayed parts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3) 4) 5) 6) 7) 8) 9)2) 10) 11) 12)
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8) [Alarm Display] button

9) [Recipe Display (Record List)] button
Places an object to list the records of a recipe.
This object must be used in combination with the recipe function.

10) [Graph] button

11) [Graphical Meter] button

12) [Slider] button
Object to specify the device value (numeric value) by sliding the knob along the bar.

■8 [Align]

1) [Align: Align left] button
Aligns the left sides of all selected figures and objects with the left side of the leftmost figure or object.

2) [Align: Center(left and right)] button
Horizontally centers all selected figures and objects.

3) [Align: Align right] button
Aligns the right sides of all selected figures and objects with the right side of the rightmost figure or object.

4) [Align: Align top] button
Aligns the top sides of all selected figures and objects with the top side of the topmost figure or object.

[Fixed Parts] Object to display the parts The displayed parts are fixed.

Item Description

[Alarm Display (User)] Object to display the alarms collected by the user alarm observation.

[Alarm Display (System)] Object to display the alarms collected by the system alarm observation.

[Simple Alarm Display] Object to display the alarms collected by monitoring the device Sets the monitored alarm 
per object.

[System Alarm Display] Object to display the alarms collected by monitoring the system Sets the monitored alarm 
per object.

Item Description

[Line Graph] Object to indicate the device values as a line graph.

[Trend Graph] Object to indicate the device values in chronological order as a graph.

[Bar Graph] Object to indicate the device values as a bar graph.

[Statistics Bar Graph] Object to indicate the ratio of each device value compared to the total value of multiple 
devices as a bar graph.

[Statistics Pie Graph] Object to indicate the ratio of each device value compared to the total value of multiple 
devices as a pie graph.

[Scatter Graph] Object to indicate the device values as a scatter graph with the X and Y coordinates 
representing two devices, respectively.

[Historical Trend Graph] Object to indicate, in chronological order as a graph, the device values collected by the 
logging function.

Item Description

[Sector Meter] Places an object to display a device value on a sector meter.

[Semicircle Meter] Places an object to display a device value on a semicircle meter.

[Bar (Vertical) Meter] Places an object to display a device value on a vertical bar meter.

[Bar (Horizontal) Meter] Places an object to display a device value on a horizontal bar meter.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3) 4) 5) 6) 7) 8) 9)2)
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5) [Align: Center(top and down)] button
Vertically centers all selected figures and objects.

6) [Align: Align bottom] button
Aligns the bottoms of all selected figures and objects with the bottom of the lowest figure or object.

7) [Align: Align equally to X] button
Evenly and horizontally aligns all selected figures and objects.

8) [Align: Align equally to Y] button
Evenly and vertically aligns all selected figures and objects.

9) [Align: Custom] button
Displays the [Align] dialog.

■9 [Draw Figure]

1) [Line Style] button
Sets the line type of a selected figure.

2) [Line Width] button
Sets the line width of a selected figure.

3) [Line Color] button
Sets the line color of a selected figure.

4) [Pattern] button
Sets the pattern of a selected figure.

5) [Shape Color] button
Sets the pattern color of a selected figure.

6) [Background Color] button
Sets the pattern background color of a selected figure.

7) [Text Color] button
Sets a text color.

8) [Style] button
Sets a character effect.

9) [Text Solid Color] button
Sets the color of the shade of a text.

■10 [Communication]

1) [Write to GOT] button
Writes data from the personal computer (GT Designer3) to the GOT.
Shortcut key: [Shift] + [F11]

2) [Read from GOT] button
Reads data from the GOT to the personal computer (GT Designer3).

3) [Verify GOT] button
Compares the project being edited with the project in the GOT.

4) [Communication Configuration] button
Sets the method of the communication between the personal computer (GT Designer3) and the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5) [Batch Write to multiple GOTs] button
Not available to GT2105-Q.
Writes data to multiple GOTs in one go with a personal computer (GT Designer3).

■11 [Diagnostics]

1) [GOT Diagnostics] button
Displays the GOT error information.

■12 [Simulator]

1) [Simulator: Start] button
Starts GT Simulator3 and executes a simulation.
Shortcut key: [Ctrl] + [F10]

2) [Simulator: Update] button
Updates the project in simulation with the project being edited.
Shortcut key: [Alt] + [F10]

3) [Simulator: Setting] button
Configures the communication settings and other settings of GT Simulator3.

4) [Simulator: End] button
Exits GT Simulator3.

■13 [GOT Offline Monitor]

1) [GOT Offline Monitor: Activate] button
Activates the GOT offline monitor.
Shortcut key: [Ctrl] + [F12]

2) [GOT Offline Monitor: Set] button
Configures the settings of the GOT offline monitor.

3) [GOT Offline Monitor: Exit] button
Exits the GOT offline monitor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3) 4)2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3)2)
2. CREATING A PROJECT
2.2 Screen Layout of GT Designer3

2 - 39



■14 [Report]

1) [Line] button
Arranges a line.

2) [Text] button
Arranges a text.

3) [Print:Numerical Print] button
Place an object to print a device value (numerical value).

4) [Print:Text Print] button
Place an object to print a device value (text).

5) [Print:Bit Comment Print] button
Place an object to print a comment.
A bit device controls the comment to be printed.

6) [Print:Word Comment Print] button
Place an object to print a comment.
A word device controls the comment to be printed.

7) [Set for Header] button
Sets the selected row as the header.

8) [Set for Footer] button
Sets the selected row as the footer.

9) [Set for Repeat] button
Sets the selected row to be repeatedly printed.

10) [Object of Selection:Report Line] button
Sets only report lines as the targets for selecting.

■15 [Coordinate/Size]

1) [X]
Sets the X coordinate of the upper left vertex of a selected figure or object in dots.

2) [Y]
Sets the Y coordinate of the upper left vertex of a selected figure or object in dots.

3) [Width]
Sets the width of a selected figure or object in dots.

4) [Height]
Sets the height of a selected figure or object in dots.

■16 [My Favorites]

Displays figures and objects registered in the favorite of the [Library] window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.2.3 Editor tab, work window

The following shows what are displayed in the editor tab and work window.

1) Work window
Area where screen editors and other windows are displayed.
The following shows the screens to be displayed in the work window.

• Screen editor
• [Environmental Setting] window
• [GOT Setup] window
• [Controller Setting] window
• [Comment List] window
• [Device List] window
• [Text List] window

2) Editor tab
Displays the tabs of the windows and screen editors which are displayed on the work window.
When a tab is selected, the corresponding window is displayed in the topmost position in the work window.

• Scroll button
Scrolls the position of a selected tab sideways.
The button can be used when tabs are too many to be displayed in 
the editor tab.

• Pull-down menu button
Displays the list of screen editors and windows being displayed in 
the work window.
This button displays a screen editor or window selected from the 
pull-down menu in the topmost position.

• Close button
Closes a selected tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

Pull-down menu button

Scroll button
Close button
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Right-click a tab to display menus to operate the tab.

To switch between displaying and hiding the editor tab, select [Display] → [Editor tab] from the menu.

• [Close this Tab]
Closes the right-clicked tab.

• [Close All Tab on the Left]
Closes all the tabs on the left side of the right-clicked tab.

• [Close All Tab on the Right]
Closes all the tabs on the right side of the right-clicked tab.

• [Close All Other]
Closes all the tabs except the right-clicked tab.

• [Close All]
Closes all the displayed tabs.
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2.2.4 Work tree

The work tree refers to the [Project] window, [System] window, or [Screen] window.
➟■1 [Project] window
■2 [System] window
■3 [Screen] window

■1 [Project] window

The [Project] window lists the settings of the whole project.
Double-click an item to display the setting dialog.

1) [System]
Displays the [System] window.

➟■2 [System] window
2) [Screen]

Displays the [Screen] window.
➟■3 [Screen] window

3) [Project Information]
Set a project title and a creator's name.

4) [Label (GT Designer3)]
Displays the list of set label groups.
Each one can be copied and pasted with the [Edit] menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Label Check] Updates labels (GT Designer3) and checks them.
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5) [Global Label]
Not available to GT21 and GS21.
Lists the imported global labels.

6) [Comment]
Lists the set comment groups.
Each one can be copied and pasted with the [Edit] menu.

7) [Alarm]

8) [Logging]
Lists the set logging settings.
Each one can be copied and pasted with the [Edit] menu.

9) [Recipe]

10) [Script]

11) [Device Data Transfer]
Lists the set device data transfer settings.
Each one can be copied and pasted with the [Edit] menu.

12) [Trigger Action]
Set actions triggered by devices or sampling.

13) [Time Action]
Set actions triggered by time.

[New] Create a label group.

Item Description

[Import/Setting]
Displays the [Global Label List] dialog.

➟6.1.4 ■2 Importing global labels
6.1.4 ■7 [Global Label List] dialog

Item Description

[New] Create a comment group.

Item Description

[Alarm Common Setting] Set devices that convert alarm files.

[User Alarm Observation]
Lists the settings of placed user alarm observation. Each one can be copied and pasted 
with the [Edit] menu. Double-click [New] to configure the settings for collecting alarms by 
monitoring devices.

[System Alarm Observation] Configure the settings for collecting alarms by monitoring the system.

[Alarm Popup Display] Configure the settings for displaying collected alarms in a popup window when the alarms 
are collected.

Item Description

[New] Configure the settings for collecting device values.

Item Description

[Recipe Common Setting] Set control devices for the recipe function.

[Recipe]
Lists the set recipe settings. Each one can be copied and pasted with the [Edit] menu. 
Double-click [New] to configure the settings for executing batch write or batch read on 
multiple devices.

Item Description

[Script] Set scripts.

[Script List] Lists the scripts.

[Script Symbol] Set script symbols.

[Object Script Symbol] Set object script symbols.

Item Description

[New] Configure the settings for transferring data between devices.

Item Description
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14) [Hard Copy]
Configure the settings for capturing the active screen on the GOT.

15) [MES Interface]
Configure the settings for sending SQL statements from the GOT to the personal computer database.

16) [Application Selection]
Select system applications to be written to the GOT.

17) [Parts]

18) [Sound]

Item Description

[Parts Image List] Lists the part images. Each one can be copied and pasted with the [Edit] menu.

[Parts Setting] Configure the part settings.

[New] Create a part.

Item Description

[Sound File List] Lists the sound files to register or edit the files.

[Touch Key Sound Setting] Configure the setting to use a specified sound file for the touch key sound.
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■2 [System] window

The [System] window lists the settings, including the GOT type settings, environmental settings, and controller settings.
Double-click an item to display the setting dialog.

1) [Type Setting]
Change the model setting of the project.

2) [Environmental Setting]

Item Description

[Screen Switching/Window] Configure the settings of screen switching.

[Language Switching] Configure the settings of language switching.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [GOT Setup]

4) [GOT Ethernet Setting]

5) [Controller Setting]
Configure the settings for communicating with controllers.
The number of channels depends on the GOT model.

6) [Network/Duplex Setting]

[Dialog Window] Configure the settings of the system message dialog window.

[Key Window] Configure the settings of key windows in the project.

[System Information] Set devices that handle the system information.

[Security] Configure the security settings for the GOT operations.

[Operation Log] Configure the settings for collecting operation history events of the GOT.

[Internal Device Retention] Configure the settings for retaining GOT internal device values.

[Kana-Kanji/Pinyin Conversion] Configure the settings of kana-kanji conversion or Pinyin conversion on the GOT.

[Startup Logo] Set the initial screen displayed at the GOT startup.

Item Description

[Basic Setting]

• [Display Setting/Language Setting]
Configure the display settings of the GOT.

• [GOT ID No.]
Set unique information to the GOT.

• [Operation Setting/Utility Call Key]
Set a buzzer sound and the utility call key for the GOT.

• [USB Host]
Configure the settings for using a mouse and keyboard on the GOT.

• [Time Setting]
Set the GOT time setting method.

• [Transparent Mode Setting]
Set the target channel for the FA transparent function.

• [GOT Internal Device Monitor]
Set whether to use the GOT internal device monitor of the GOT diagnostics function.

[Advanced Setting]

• [SoftGOT-GOT Link]
Configure the settings for the SoftGOT-GOT link function.

• [VNC Server]
Configure the settings for the VNC server function.

• [Sequence Program Monitor]
Configure the settings for the sequence program monitor.

• [Backup/Restoration]
Configure the settings for the backup/restoration function.

• [Wireless LAN Setting]
Configure the wireless LAN settings.

• [System Launcher]
Configure the system launcher settings.

• [iQSS Utility]
Configure the iQSS utility settings.

• [Network Drive]
Configure the network drive settings.

Item Description

[GOT IP Address Setting] Set the IP address of the GOT.

[GOT Ethernet Common Setting] Configure the GOT Ethernet setting.

[IP filter Setting] Configure the IP filter setting.

Item Description

[Routing Information] Configure the settings for monitoring other networks.

Item Description
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7) [Buffer Memory Unit No. Switching]
Configure the settings for switching the buffer memory unit No. of the monitoring target.

8) [Peripheral Unit Setting]

9) [GOT Network Interaction]
Configure the settings for controlling pieces of equipment on the same network to prevent simultaneous operations.

10) [GOT Mobile Setting]
Configure the settings for using the GOT as the server in the GOT Mobile function.

11) [I/F Communication Setting]
Lists the interface settings of the GOT.

[Gateway]

• [Communication Setting]
Configure the communication settings for the server/client function.

• [Gateway Server]
Configures the settings of the server function.

• [Gateway Client]
Configure the settings for the server function.

• [Mail]
Configure the settings for the mail send function.

• [FTP Server]
Configure the settings for the FTP server function.

• [File Transfer]
Configure the settings for the file transfer function (FTP transfer or GOT internal transfer).

[MELSEC Redundant] Configure the settings for monitoring the MELSEC redundant system.

[Station No. Switching] Configure the settings for switching the station number of the monitoring target.

Item Description

[PC (Data Transfer)] Set the interface for connecting GT Designer3 (personal computer) with the GOT.

[Bar Code] Configure the settings for using a barcode reader on the GOT.

[RFID] Configure the settings for using a RFID controller on the GOT.

[PC Remote Operation] Configure the settings for operating the personal computer from the GOT.

[VNC Server] Configure the settings for viewing the GOT display contents from the personal computer.

[Video/RGB Input] Configure the settings for displaying the video data taken with a video camera on the GOT.

[Multimedia] Configure the settings for recording or playing the video data taken with a video camera on 
the GOT.

[External I/O / Operation Panel] Configure the settings for using an external I/O device and operation panel with the GOT.

[HDMI/RGB Output] Configure the settings for outputting the GOT screen data to an external display.

[Printer] Configure the settings for using a printer on the GOT.

[Sound Output] Configure the setting for outputting sounds from the GOT.

[GOT (Extended Computer)] Set the interface for the connection to the GOT (Extended Computer).

Item Description
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■3 [Screen] window

The [Screen] window lists the created base screens, window screens, report screens, and mobile screens.
Double-click an item to display the setting dialog.

1) [Unfold All] button
Expands the tree.

2) [Fold All] button
Collapses the tree.

3) [Overlay Screen] button
Displays or hides the hierarchy of set overlay screens in the tree.

4) [Script (Screen)] button
Displays or hides the screen script settings in the tree.

5) [Trigger Action (Screen)] button
Displays or hides the screen trigger action settings in the tree.

6) [Screen Design]
Displays the [Screen Design] dialog.
Screen designs are copied or pasted from the right-click menu.

7) [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen]
Lists the created base screens, window screens, report screens, and mobile screens.
Each one can be copied and pasted with the [Edit] menu.
The copied screen appears after it is pasted in the list.
When displaying and editing the screens are prohibited by the project security, the list is displayed as shown below.

Item Description

[New] Create a base screen, window screen, report screen, or mobile screen.

[Report Setting] Configure the settings for the report function.

[GOT Mobile Setting] Configure the settings for using the GOT as the server in the GOT Mobile function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.2.5 Status bar

Displays the following contents according to the position of the mouse cursor, a selected figure, or object.
• Description of the item over which the mouse cursor is moved.
• The GOT type, color settings, and controller settings of the project being edited.
• Coordinates of a selected figure or object

Switch between displaying and hiding the status bar by selecting [Display] → [Status bar] from the menu.
If system labels or global labels are used, the icon notifying the change appears when there is a change in the labels.

➟6.1.3 ■4 (4) System label update notification
6.1.4 ■2 (3) Notifying and updating a change in the global labels

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.3 Creating and Editing a Project

➟2.3.1 Creating a project
2.3.2 Opening a project
2.3.3 Closing a project
2.3.4 Deleting a project
2.3.5 Giving a title to a project

2.3.1 Creating a project

The following shows how to create a project.
• Creating a new project

Create a new project.
By using the wizard, you can configure required settings accordingly.
At the default setting, the wizard is displayed.

➟■1 Using the wizard
You can also create a project without using the wizard.

➟■2 Without using the wizard
• Creating a project utilizing a saved project

Search a project that can be utilized from stored projects by specifying conditions such as a keyword.
You can create a project based on the searched project.

➟11.1 Searching for Utilizable Data (Utilize Data)

Operating on iQ Works
A new project cannot be created with GT Designer3 when GT Designer3 is started from MELSOFT Navigator.
Create a new project with MELSOFT Navigator.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 Using the wizard

The following shows an example of creating a GT27 project.
Step 1 Either of the following operations displays the [New Project Wizard] dialog.

• Click the [New] button in the [Select Project] dialog.
• Select [Project] → [New] from the menu.

Step 2 Click the [Next] button.

1) [Display New Project Wizard]
Select this item to display the wizard when creating a new project.
You can display or hide the wizard also in the [Operation] tab of the [Option] dialog.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)
Step 3 Set [Series] and [Type] then click the [Next] button.

1) [Series]
Select the GOT series.

• [GOT2000]:
Creates a project for the GOT2000 series.

• [GS Series]:
Creates a project for the GS series.

• [GOT1000]:
Creates a project for the GOT1000 series by starting GT Designer3 (GOT1000).
Click the [OK] button, and then the confirmation message appears.

2) [GOT Type]
Select the GOT model.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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The following shows the items to be selected.
• When [GOT2000] is selected for [Series]

[GT27**-X (1024x768)]
[GT27**-S (800x600)]
[GT27**-V (640x480)]
[GT2705-V (640x480)]
[GT25**-WX (1280x800)]
[GT25**-W (800x480)]
[GT25**-S (800x600)]
[GT25**-V (640x480)]
[GT2505-V (640x480)]
[GT23**-V (640x480)]
[GT2107-W (800x480)]
[GT2105-Q (320x240)]
[GT2104-R (480x272)]
[GT2104-P (384x128)]
[GT2103-P (320x128)]
[GT SoftGOT2000]

• When [GS Series] is selected for [Series]
[GS25**-WX(1280x800)]
[GS21**-W-N (800x480)]
[GS21**-W (800x480)]

In [Name], you can check the model names of the GOTs that belong to the selected model.
➟1.1.2 Supported models

If you select [GT SoftGOT2000], set the resolution.

3) [Name]
Names of the GOT models that belong to the selected model in [GOT Type].

4) [Setup Direction]
Not available to GT SoftGOT2000.
Set the installation direction of the GOT.
The following shows the items to be selected.

• [Horizontal]
• [Vertical]

5) [Color Setting]
Displays the number of display colors of the GOT type selected in [Type].
When [GT2105-Q (320x240)] is selected for [Type], select the number of display colors.
The following shows the items to be selected.

• [65536 Colors]
• [32(Grayscale)]

6) [Graphics Setting]
Not available to GT23 because the setting is fixed to [GOT Graphic Ver.1].
The following shows the items to be selected.

Item Description

[Resolution]

Select the resolution of GT SoftGOT2000.
The following shows the items to be selected.
• [MI3315G-W (1024x768)]

Select [Full Screen Mode] or [Window Mode].
• [MI3321G-W (1920x1080)]

Select [Full Screen Mode] or [Window Mode].
• [VGA (640x480)]
• [SVGA (800x600)]
• [XGA (1024x768)]
• [HD (1280x720)]
• [WXGA (1280x800)]
• [FWXGA (1366x768)]
• [Full HD (1920x1080)]
• [WUXGA (1920x1200)]
To customize the resolution, set [X] and [Y].
When [X] or [Y] is set, [Resolution] is set to [Custom].
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• [GOT Graphic Ver.2]
• [GOT Graphic Ver.1]

For the details of the graphics modes, refer to the following.
➟5.1.2 Graphics mode ([Graphics Setting])

7) [Package Folder Name]
Set the name of the folder that stores the package data.
Use up to 32 alphanumeric characters and symbols for the folder name.
For the character strings available and unavailable for folder names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
This item is required for project creation. Always set this item.

8) [Use the gesture function]
Only available to GT27.
Enables the GOT operation by gesture.

➟11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen Gesture Function)
11.13 Operating Objects by the Gesture (Object Gesture Function)

9) [Enable the graphics accelerator to smooth the screen gesture and document display 
operations]
Only available to GT27.

Enables the graphics accelerator for the screen gesture function and the document display.
When the graphics accelerator is enabled, the operations of the screen gesture function and the documentdisplay 
become smooth.

➟5.1.5 [Type Setting] dialog
Note that the GOT startup time becomes long.

➟11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen Gesture Function)
8.26.3 How to use the document display (for Document Converter output files)

To use the graphics accelerator, install the CoreOS version E or later to the GOT.
➟4.5.3 Installing the BootOS or the CoreOS to the GOT

For how to check the CoreOS version, refer to the following.
➟GOT2000 Series User's Manual (Utility)

10) [Expand base screen sizes]
Available to GT27, GT25, and GS25.

Enables you to set a larger base screen by setting higher resolution than the original GOT resolution.
For details on the base screen size expansion, refer to the following.

➟5.1.3 Base screen size expansion ([Expand base screen sizes])
Click the [Display Setting] button to display the [Display Setting] dialog.
Configure the settings for displaying the scroll bars and navigation window on the GOT.

➟5.1.5 ■1 (1) [Display Setting] dialog (Base screen size expansion)
Step 4 Check the settings made in step 3, and click the [Next] button.

Step 5 Set [Manufacturer] and [Controller Type] then click the [Next] button.
(For GT SoftGOT2000, proceed to step 8.)

GOT Graphic Ver.1

GOT Graphic Ver.2
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1) [Manufacturer]
Select the manufacturer of the controller connected to the GOT.

2) [Controller Type]
Select the controller type connected to the GOT.
For the controllers that belong to the type selected with [Controller Type], refer to the following.

➟12.2 Correspondence between the setting of [Controller Type] and the controller used
Step 6 Select [I/F] then click the [Next] button.

1) [I/F]
Select the interface of the GOT that connects the controller.

Step 7 Set [Communication Driver] and click the [Next] button.

1) [Communication Driver]
Select the communication driver according to the connection type of the GOT and controller.
Selectable communication driver differs depending on the settings of [Manufacturer], [Controller Type], and [I/F].
Configure the setting according to the controller and the connection type used.

1)

2)

1)

1)
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➟GOT2000 Series Connection Manual for a controller used

Step 8 When the settings for the controller are complete, click the [Next] button.
(If an Ethernet interface of the GOT is deselected, or if GT SoftGOT2000 is used, proceed to step 10.)
To add other controllers, click the [Add] button.
(Proceed to step 5.)

You can change or add the controller settings in the [Controller Setting] window.
➟5.5.1 ■4 [Controller Setting]

Step 9 Configure the GOT Ethernet setting, and click the [Next] button.

1) [GOT IP Address]
Set the IP address of the GOT.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

2) [Subnet Mask]
Set the subnet mask for the GOT.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

3) [Default Gateway]
Set the default gateway.
The setting range is [0.0.0.0] to [255.255.255.255].

4) [Peripheral S/W Communication Port No.]
Set the port No. used for the communication with GT Designer3.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

5) [Transparent Port No.]
Set the port number used for the FA transparent function.

Item Description

[Detail Setting] button
Click this button to display the [Detail Setting] dialog.
The setting items differ depending on the [Communication Driver] setting.

➟GOT2000 Series Connection Manual for a controller used

1)
2)
3)
4)
5)
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The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

Step 10 Set screen switching devices for the base screen and other necessary windows then click the [Next] button.
You can also set the screen switching devices in the [Environmental Setting] window.

➟5.2.1 ■5 [Screen Switching/Window]

1) [Base Screen]
Set a screen switching device for a base screen.

2) Overlap window
Set screen switching devices for overlap window 1 to 5.
For GT23, GT21, and GS21, you can set the screen switching devices for overlap window 1 and 2 only.

3) Superimpose window
Set screen switching devices for superimpose window 1 and 2.

4) [Dialog Window]
Set a screen switching device for a dialog window.

Step 11 Select a screen design, and click the [Next] button.
The selected design is applied to all target screens in the project.
The selectable designs differ depending on the selection for [Graphics Setting] in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

You can also select a screen design in the [Screen Design] dialog.
➟2.4.3 [Screen Design] dialog

Step 12 Check the settings with the wizard then click the [Finish] button to complete the settings.

1)

2)

3)

4)

Design list
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■2 Without using the wizard

You can set whether to display or not the wizard when creating a new project in the [Operation] tab of the [Option] dialog.
At the default setting, the wizard is displayed.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)

(1) Setting a model when creating a new project
If the settings of the [Operation] tab of the [Option] dialog are configured as described below, the [GOT Type Setting] 
dialog and the [Controller Setting] window appear when a new project is created.

• [Display New Project Wizard] is cleared.
• [Perform type setting at the time of creating a new project] is selected.
Step 1 Either of the following operations displays the [GOT Type Setting] dialog.

• Click the [New] button in the [Select Project] dialog.
• Select [Project] → [New] from the menu.

Step 2 Click the [OK] button after the required settings.

➟5.1.5 [Type Setting] dialog

Step 3 A project is created and the [Controller Setting] window appears.
Step 4 Select the manufacturer, model, GOT interface, and communication driver for the controller to be connected 

then click the [OK] button.

➟5.5.1 ■4 [Controller Setting]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 5 Select [Common] → [GOT Environmental Setting] → [Screen Switching/Window] from the menu to display 
the [Screen Switching/Window] window of the [Environmental Setting] window.

Step 6 Set screen switching devices for the base screen and other necessary windows then click the [OK] button.

➟5.2.1 ■5 [Screen Switching/Window]

(2) Creating a new project without setting a model
If the settings of the [Operation] tab of the [Option] dialog are configured as described below, the project is created with 
the model setting of the last edited project.

• [Display New Project Wizard] is cleared.
• [Perform type setting at the time of creating a new project] is cleared.
2. CREATING A PROJECT
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■3 Searching a utilizable project

Search a project that can be utilized from sample projects or saved projects with a keyword.
You can create a project efficiently by utilizing an existing project.

➟11.1 Searching for Utilizable Data (Utilize Data)

2.3.2 Opening a project

In GT Designer3, you can open projects of the following formats.

(1) Project to which a security key is assigned
To open a project to which a security key is assigned, GT Designer3 must have the matched security key.

➟2.12 Protecting a Project with a Security Key
(2) Project for which project security is set

When a project for which project security is set is about to be opened, the system requires user 
authentication.

➟2.13 Protecting a Project by Registering Users
(3) Operating on iQ Works

(a) Opening a project
A project cannot be opened with GT Designer3 when GT Designer3 is started from MELSOFT 
Navigator.
Open a project with MELSOFT Navigator.

(b) Project format
When GT Designer3 is started from MELSOFT Navigator, the project format that can be handled with 
GT Designer3 is the workspace format project only.
When using a single file format project, save the project in the workspace created with MELSOFT 
Navigator with the following procedure.
Step 1. Start only GT Designer3, and then open the single file format project.
Step 2. Select [Project] → [Save As] from the menu, and save the project in a workspace of MELSOFT 
Navigator as a workspace format project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Available project format

GOT2000 Series

• Workspace format
• Single file format (*.GTX, *.GTXS, *.G2, *.GTCNV)
You can transfer a project with a system application (package data) to the GOT without opening the project. 
You cannot open a project that has the workspace format if another user has opened the project. 
A single file format project (*.GTX, *.GTXS) opens in a read-only mode if another user has opened the project. 
You cannot save the read-only project.
➟■1 Opening a project for GOT2000

GOT1000 Series

• Workspace format
• Single file format (*.GTW, *.GTE, *.G1)
There are two alternatives: convert a project into the GOT2000 equivalent, or start GT Designer3 (GOT1000) to edit the project 
with keeping a GOT1000 project.
➟■2 Opening a project for GOT1000

GOT900 Series

• Single file format (*.GTD)
Converts the project into the GOT1000 equivalent by starting GT Designer3 (GOT1000). 
To edit the project as a GOT900 project, use GT Designer2 Classic. 
To convert the project into the GOT2000 equivalent, convert the project into the GOT1000 equivalent in advance.
➟■3 Opening a project for GOT900
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■1 Opening a project for GOT2000

Step 1 Select [Project] → [Open] from the menu to display the [Open Project] dialog.
Switch the screens according to the format of the project.

• Workspace format: Open the project from the [Open Project] dialog (workspace format).
➟■4 [Open Project] dialog (workspace format)

• Single file format: Open the project from the [Open Project] dialog (single file format).
➟■5 [Open Project] dialog (single file format)

Step 2 In the [Open Project] dialog, select the project , and then click the [Open] button to open the project.
When the project with a system application (package data) is opened, the following dialog appears.

By clicking the [Write to the GOT without Open] button, you can transfer the project to the GOT without 
opening the project.
To write package data to multiple GOTs without opening the relevant project, click the [Batch Write to 
multiple GOTs without opening] button.

➟4. COMMUNICATING WITH GOT

■2 Opening a project for GOT1000

Step 1 Select [Project] → [Open] from the menu to display the [Open Project] dialog.
Switch the screens according to the format of the project.

• Workspace format: Open the project from the [Open Project] dialog (workspace format).
➟■4 [Open Project] dialog (workspace format)

• Single file format: Open the project from the [Open Project] dialog (single file format).
➟■5 [Open Project] dialog (single file format)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Switching to the [Open Project] dialog (single file format) Switching to the [Open Project] dialog (workspace format)

[Open Project] dialog (workspace format) [Open Project] dialog (single file format)
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Step 2 In the [Open Project] dialog, select the project , and then click the [Open] button to display the following 
dialog.

Step 3 Select the editing method of the project and click the [OK] button.
• [Start GT Designer3 (GOT1000) and edit the GOT1000 data as is]

GT Designer3 (GOT1000) is started then the project is opened.
• [Convert the project to GOT2000 data and edit it in GT Designer3 (GOT2000)]

A project is converted to the GOT2000 equivalent.
The [GOT Type Setting] dialog appears.
Proceed to the step 4.

Step 4 Set the GOT type that the project belongs to after the conversion and click the [OK] button. The project is 
converted then opens.

➟5.1.5 [Type Setting] dialog

Switching to the [Open Project] dialog (single file format) Switching to the [Open Project] dialog (workspace format)

[Open Project] dialog (workspace format) [Open Project] dialog (single file format)
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Step 5 The conversion operation is listed in the [Output] window.

➟5.1.6 [Output] window

■3 Opening a project for GOT900

Step 1 Select [Project] → [Open] from the menu to display the [Open Project] dialog.
When the [Open Project] dialog (workspace format) appears, switch the dialog to the [Open Project] dialog 
(single file format).

➟■5 [Open Project] dialog (single file format)

Step 2 In the [Open Project] dialog (single file format), select the project , and then click the [Open] button to display 
the following dialog.

Step 3 Click the [Yes] button to switch the screen design software to GT Designer3 (GOT1000).
Convert the project into the GOT1000 equivalent by using GT Designer3 (GOT1000).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Switching to the [Open Project] dialog (single file format)

[Open Project] dialog (workspace format) [Open Project] dialog (single file format)
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■4 [Open Project] dialog (workspace format)

1) [Save Folder Path]
Set the destination path to save the project.
The path can be set from the [Browse] button.

2) [Workspace/Project List]
The workspaces and projects in the path set in the [Save Folder Path] are displayed.
If a workspace is double-clicked, the projects in the workspace are displayed.
If the [Open] button is clicked, a selected project opens.

3) [Workspace Name]
Displays the workspace name selected in [Workspace/Project List].

4) [Project Name]
Displays the project name selected in [Workspace/Project List].
Up to 200 characters can be used for the total number of the characters of [Save Folder Path], [Workspace Name], 
and [Project Name].
"\" at the end of the project name is not counted as a character.

5) [Open single file format project] button
Switches the dialog to the [Open Project] dialog (single file format).

➟■5 [Open Project] dialog (single file format)

Project not displayed in [Workspace/Project List]
The following workspace and project are not displayed in [Workspace/Project List].

• Workspace that does not have the workspace management file
• Project that does not have the project management file
• Workspace that has not been registered to the workspace management file
• Project that has not been registered to the workspace management file

Do not operate (migrate, rename, or delete) the folders or files in the workspace by using Windows Explorer or 
others.
Otherwise, the states listed above and thus they cannot be opened.

Item Description

[Display]

Select the target projects to be displayed in [Workspace/Project List].
• [All Folder]: Displays GOT2000 projects and GOT1000 projects.
• [GOT2000 Project]: Displays GOT2000 projects.
• [GOT1000 Project]: Displays GOT1000 projects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
4)

5)
2 - 64 2. CREATING A PROJECT
2.3 Creating and Editing a Project



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

■5 [Open Project] dialog (single file format)

1) [Look in]
Select a location where the project has been saved.

2) File list
Lists the files saved in the location specified in [Look in].

3) [File name]
Input the file name of the project to be opened.
Click the [Open] button to open the project having the input file name.

4) [Files of type]
Select the file type of the files to be displayed in the file list.

• [All file (*.GTX;*.GTXS;*.G2;*.GTCNV;*.GTW;*.GTE;*.G1;*.GTD)]
• [GOT2000 File (*.GTX;*GTXS;*.G2;*.GTCNV)]
• [GOT1000 File (*.GTW;*.GTE;*.G1)]
• [GOT900 File (*.GTD)]

5) [Open workspace format project] button
Switches the dialog to the [Open Project] dialog (workspace format).

➟■4 [Open Project] dialog (workspace format)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)
4)

5)

2)
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Opening a single file format project (*.G2) in which a system label has been set
When a single file format project (*.G2) is opened, the system label set in the project cannot be used if the project 
in the original workspace format does not exist.
If the project in the original workspace format does not exist, save the project with the G2 format as the 
workspace format with the following procedure.

Step 1 Use GT Designer3 to open a G2 format project in which a system label is set. The following dialog 
appears.

Step 2 Click the [Yes] button.
Step 3 Select [Project] → [Save as] from the menu and save the G2 format project in the original workspace.

You can use the system label properly.

2.3.3 Closing a project

Select [Project] → [Close] from the menu to close the project.
When GT Designer3 is started from MELSOFT Navigator, [Close] cannot be selected from the menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.3.4 Deleting a project

➟■1 Deleting a workspace format project
■2 Deleting a single file format project

■1 Deleting a workspace format project

Step 1 Select [Project] → [Delete] from the menu to display the [Delete Project] dialog.
Step 2 Select a project to be deleted from [Workspace/Project List] and click the [Delete] button. The selected 

project is deleted.

(1) [Delete Project] dialog

1) [Save Folder Path]
Set the destination path to save the project.
The path can be set from the [Browse] button.

2) [Workspace/Project List]
The workspaces and projects in the path set in the [Save Folder Path] are displayed.
If a workspace is double-clicked, the projects in the workspace are displayed.
Click the [Delete] button to delete the selected project.

3) [Workspace Name]
Displays the workspace name selected in [Workspace/Project List].

4) [Project Name]
Displays the project name selected in [Workspace/Project List].

■2 Deleting a single file format project

Delete files of the project using Windows Explorer or other methods.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Item Description

[Display]

Select the target projects to be displayed in [Workspace/Project List]. 
The following shows the items to be selected.
• [GOT2000 Project]
• [GOT1000 Project]

1)

2)

3)
4)
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2.3.5 Giving a title to a project

Set a title, a creator's name, and other information for a project.
Step 1 Select [Project] → [Project Information] from the menu to display the [Project Information] dialog.
Step 2 Set each item, and then click the [OK] button to complete the settings.

■1 [Project Information] dialog

1) [Project Title]
Set the title for the project.
Up to 32 characters can be set.

2) [Project ID]
Set a project ID.
A project ID is automatically given to the project when a project is created.
The setting range is [1] to [4294967295].

3) [Detailed Description]
Set text information for the project.
Up to 512 characters can be set.
A line feed is counted as two characters.

4) [Created By]
Set the creator's name of the project.
Up to 64 characters can be set.

5) [Last Update]
Displays the latest date and time at which the project was saved and the GT Designer3 version.
Click the [Detail] button to display the [Edit Version History] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

• Edit history
The edit history of the project is displayed.

• [Delete Edit History] button
Deletes the edit history.

1)

2)

3)

4)

5)

6)

7)

Edit history
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6) [Include projects for the function of Utilize Data]
Enables the following.

• The current project is included in the search targets for creating a project based on another project.
• The display of screen images in the [Screen Image List] window or [Screen Image List] dialog is sped up.

7) [MELSOFT iQ AppPortal information file output when saving project]
Select the setting to output a MELSOFT iQ AppPortal information file when a workspace format project or a single 
file format project (*.GTX or *.GTXS) is saved.
The following shows the items to be selected.

• [Always output]
Outputs a MELSOFT iQ AppPortal information file each time the project is saved.

• [Output only when information file exists]
Overwrites an existing MELSOFT iQ AppPortal information file when the project is saved.

• [Not output (delete information file)]
Does not output a MELSOFT iQ AppPortal information file when the project is saved.
Deletes an existing MELSOFT iQ AppPortal information file.

For the details of MELSOFT iQ AppPortal, refer to the following.
➟iQ AppPortal Operating Manual
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2.4 Setting a Screen Design

You can collectively configure the settings such as the background color for base screens, windows screens, and mobile 
screens of a screen design.

The following settings are available for a screen design.
• Pre-installed screen designs

Select one of the screen designs pre-installed in GT Designer3.
You can easily set a screen design without paying attention to the setting items.

• Customized screen designs
Customize a screen design.
You can customize the background color, design of window screens, and other settings of a screen design selected 
from the pre-installed screen designs.

A screen design is composed of the following settings.

Screen Setting item

Base screen
• Background color
• Gradation
• Pattern

Window screen

• Background color
• Gradation
• Pattern
• Transparency
• Screen contours
• Radius
• Window design
• Shadow

Mobile screen
• Background color
• Gradation
• Pattern

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting a design

Pre-installed screen designs Customized screen designs

Base screen Mobile screen Window screen
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2.4.1 Selecting a screen design

In the following locations, select a screen design that is applied to all target screens in the project.
• New project wizard

➟2.3.1 ■1 Using the wizard
• [Screen Design] dialog

➟■1 Changing the screen design of all screens

To customize the screen design of each screen, configure the settings in the [Screen Property] dialog.
➟■2 Customizing the screen design for each screen

■1 Changing the screen design of all screens
A newly selected screen design is applied to all base screens, window screens, and mobile screens in the project.

➟(1) Selecting a pre-installed screen design
(2) Customizing a screen design

(1) Selecting a pre-installed screen design
The following shows how to set a screen design when [Preset] is selected in the [Screen Design] dialog.

Step 1 Select [Screen] → [Screen Design] from the menu to display the [Screen Design] dialog.

➟2.4.3 [Screen Design] dialog
Step 2 Select a design from the design list to preview the selected design on the screen editor.
Step 3 Click the [OK] button to apply the design to all target screens.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Selected designSelected design

Select a design to 
preview the design 
on the screen editor.
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(2) Customizing a screen design
The following shows how to set a screen design when [Custom] is selected in the [Screen Design] dialog.

Step 1 Select [Screen] → [Screen Design] from the menu to display the [Screen Design] dialog.

➟2.4.3 [Screen Design] dialog
Step 2 Select [Custom], and change each setting.

The change is applied to the preview of the screen editor.
Step 3 Click the [OK] button to apply the design to all target screens.

Setting to be changedSetting to be changed

The new setting is 
applied to the preview 
of the screen editor.
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■2 Customizing the screen design for each screen
Customize the screen design for each screen in the [Screen Property] dialog.
For the [Screen Property] dialog for each screen type, refer to the following.

➟2.7.1 Property of base screens
2.7.2 Properties of window screens
10.19.7 Mobile screen properties

The following shows the procedure for setting an individual screen design for base screen 1 as an example.
Step 1 Select base screen 1.
Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog.

Step 3 Select [Individually set the screen design] to enable the individual screen design setting.
Step 4 Set [Screen Design] and click the [OK] button to apply the setting to base screen 1.

1.

2.

[Screen Design]
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2.4.2 Precautions

■1 Precautions for drawing
(1) Project for which project security is set

When editing the project is prohibited, you cannot perform the following operations.
• Changing the screen designs in the [Screen Design] dialog
• Pasting a copied screen design

(2) Behavior when the [Reflect the setting in all screens] button is clicked
The specified design is not applied to the screens satisfying all the following conditions.

• Editing a screen is prohibited by the project security.
• [Individually set the screen design] is selected in the [Screen Property] dialog.

■2 Precautions for use
(1) Display of a screen with a gradient background on the GOT

As the screen display method differs between the GOT and a personal computer, a screen with a gradient background 
may look different on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.4.3 [Screen Design] dialog

Select [Screen] → [Screen Design] from the menu to display the [Screen Design] dialog.
The set design is applied to all base screens, window screens, and mobile screens in the project.
The screen design setting is saved when the project is saved.
The saved screen design setting is retained upon exit from GT Designer3 and applied at the next GT Designer3 startup.

1) [Preset]
Displays screen designs.
Select a design.

➟■1 [Preset]
2) [Custom]

Displays customizable settings for base screens, window screens, and mobile screens.
Customize the settings of the screen design selected from the pre-installed screen designs.

➟■2 [Custom]
3) [Reflect the setting in all screens] button

Applies the set design to all screens.
The design is also applied to a screen for which [Individually set the screen design] is selected in the [Screen 
Property] dialog.
Upon the application of the design, [Individually set the screen design] is deselected in the [Screen Property] dialog.
After clicking this button, you cannot restore the screens to their former design.

4) [OK] button
Applies the set design to all screens.
The design is not applied to a screen for which [Individually set the screen design] is selected in the [Screen 
Property] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3) 4)
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■1 [Preset]

1) Design list
Select a screen design.
Click the pull-down menu button to display all designs.
The selectable designs differ depending on the selection for [Graphics Setting] in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 [Custom]
Customize the settings for base screens, window screens, and mobile screens.
Customize the background color, transparency, and other settings based on the screen design setting selected in 
[Preset].
Customizable setting items vary according to the screen type.
When you select a screen design in [Preset] while changing the settings in [Custom], the changes in [Custom] are 
canceled and the screen design selected in [Preset] is set.

1) [Base Screen]
Select a background color for base screens.
For the color setting, refer to the following.

➟6.4.2 Color settings
2) [Window Screen]

Set the design for window screens.

1)

Pull-down menu button

Item Description

[Background Color]
Select a background color.
For the color setting, refer to the following.

➟6.4.2 Color settings

1)

2)

3)

4)
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3) [Mobile Screen]
Select a background color for mobile screens.
For the color setting, refer to the following.

➟6.4.2 Color settings
4) [Preview]

Previews a base screen, window screen, mobile screen, and standard key window.

[Transparency]
Set the transparency of the window screen.
The setting range is [0]% to [100]%.

[Screen Contour] Set the contours of the window screen.
The following shows the items to be selected.
• [Rectangle]
• [Rounded]

[Radius] When [Rounded] is selected for [Screen Contour], set the circle radius.
The setting range is [0] to [599].
The radius may be adjusted automatically depending on the size of the window screen.

[Window Design]

Set a design for the title bar of window screens and the standard key window.
The following shows the items to be selected.
• [Basic]
• [Stylish]
• [Dark Tone Flat]
• [Light Tone Flat]
• [Classic]

[Shadow]
Set a shadow to window screens and the standard key window.
The following shows the items to be selected.
• [Outer]
• [Bottom Right]
• [None]

Item Description

GOT Graphic Ver.2

GOT Graphic Ver.2

GOT Graphic Ver.2

GOT Graphic Ver.2

GOT Graphic Ver.2
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2.5 Creating, Opening, and Closing a Screen

➟2.5.1 Creating a screen
2.5.2 Opening and closing screens

2.5.1 Creating a screen

The following shows how to create a screen.
• Creating a screen

Create a base screen, window screen, or report screen.
➟■1 Creating a base screen
■2 Creating a window screen
■3 Creating a report screen

Create a mobile screen.
➟10.19.7 Mobile screen properties

You can create a window screen to be displayed on the GOT as a dialog window efficiently by using the wizard.
➟■4 Creating a window screen for a dialog window

• Creating a screen utilizing a saved project
Search sample projects and saved projects for a screen to be utilized with keywords. 
You can create a screen efficiently by utilizing.

➟11.1 Searching for Utilizable Data (Utilize Data)

Editing a project for which project security is set
If a login user has access on which project editing is banned, the user cannot create any screen.
➟2.13 Protecting a Project by Registering Users

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 Creating a base screen

Step 1 Either of the following operations displays the [Screen Property] dialog.
• Select [Screen] → [New] → [Base Screen] from the menu.
• Double-click [Base Screen] → [New] on the tree in the [Screen] window.

Step 2 Click the [OK] button after the required settings.

➟2.7.1 Property of base screens
Step 3 A base screen is created and a screen editor appears on the work window.

How to expand the base screen size
For GT27, GT25, and GS25, you can create base screens that are larger than the GOT screen by enabling the 
base screen size expansion.
For details on the base screen size expansion, refer to the following.
➟5.1.3 Base screen size expansion ([Expand base screen sizes])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Creating a window screen

Step 1 Either of the following operations displays the [Screen Property] dialog.
• Select [Screen] → [New] → [Window Screen] from the menu.
• Double-click [Window Screen] → [New] on the tree in the [Screen] window.

Step 2 Click the [OK] button after the required settings.

➟2.7.2 Properties of window screens
Step 3 A window screen is created and a screen editor appears on the work window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
2 - 80 2. CREATING A PROJECT
2.5 Creating, Opening, and Closing a Screen



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

■3 Creating a report screen

Not available to GT25HS-V.
Step 1 Either of the following operations displays the [Screen Property] dialog.

• Select [Screen] → [New] → [Report Screen] from the menu.
• Double-click [Report Screen] → [New] on the tree in the [Screen] window.

Step 2 Click the [OK] button after the required settings.

➟2.7.3 Property of report screens
Step 3 A report screen is created and a screen editor appears on the work window.

■4 Creating a window screen for a dialog window

Step 1 Select [Screen] → [New] → [Dialog Window Wizard] to display the [Dialog Window Wizard] dialog.

➟(1) [Dialog Window Wizard] dialog
Step 2 Click the [OK] button after the required settings.
Step 3 A window screen is created and a screen editor appears on the work window.

Example)
• [Set the dialog title and the Close button]: selected
• [Type]: [!]
• [Button]: [Yes or No]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) [Dialog Window Wizard] dialog

1) [Screen No.]
Set a screen number.
The setting range is [1] to [32767].

2) [Title]
Set the title of the screen.
Up to 32 characters can be set.

3) [Screen Background]
Select a pattern, pattern color, and pattern background color of the screen.
The pattern is displayed over the background color.

4) [Set the dialog title and the Close button]
Select this item to arrange the dialog title and a close button on the window screen.

5) [Type]
Select an icon to be arranged on the window screen.
When an icon is selected, the image of the icon is displayed on the [Dialog Window Wizard] dialog.

6) [Button]
Select the type of a button to be arranged on the window screen.

■5 Searching a screen to be utilized

Search sample projects and saved projects for a screen to be utilized with keywords.
You can create a screen efficiently by utilizing.

➟11.1 Searching for Utilizable Data (Utilize Data)

1)
2)

3)

4)

5)

6)

Pattern + Pattern color

Pattern background color

Example)
Pattern
Pattern color :

:

Pattern 
background color :
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2.5.2 Opening and closing screens

➟■1 Opening screens
■2 Closing screens

■1 Opening screens

➟(1) Opening screens from the [Screen] window
(2) Opening screens from the [Screen Image List] window
(3) Opening screens from the menu

Up to 25 screens can be opened.
A number smaller than 25 can be set as the maximum number of screens that can be opened.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)

Project for which project security is set
When project security is set for each screen, displaying or editing screens is disabled according to the access 
level set for each screen.
➟2.13 Protecting a Project by Registering Users

(1) Opening screens from the [Screen] window

(a) Opening screens one by one
Double-click the screen to be opened on the [Screen] window to display a screen editor on the work window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Opening multiple screens simultaneously
Step 1 Select multiple screens to be opened while pressing the [Ctrl] or [Shift] key.

Step 2 Either of the following operations displays a screen editor on the work window.
• Press the [Enter] key.
• Right-click on the selected screen and select [Open] from the menu.

(2) Opening screens from the [Screen Image List] window

Base screens, window screens, and mobile screens are displayable from the [Screen Image List] window.
Step 1 Select [Display] → [Docking Window] → [Screen Image List] from the menu to display the [Screen Image 

List] window.

➟2.8.1 [Screen Image List] window

Step 2 Double-click the image of a screen to be opened to display a screen editor on the work window.
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(3) Opening screens from the menu

(a) Opening a screen specifying the screen number
Step 1 Select [Screen] → [Open] from the menu to display the [Open Screen] dialog.

➟■3 [Open Screen] dialog

Step 2 Click the [Number Specification] button to display the [Number Specification] dialog.

Step 3 Set [Screen Type] and [Screen No.] then click the [Open] button to display a screen editor on the work 
window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
2. CREATING A PROJECT
2.5 Creating, Opening, and Closing a Screen

2 - 85



(b) Opening a screen checking the corresponding screen image
Step 1 Select [Screen] → [Open] from the menu to display the [Open Screen] dialog.

➟■3 [Open Screen] dialog

Step 2 Click the [Specify Image] button to display the [Screen Image List] dialog.

Step 3 Select a screen and click the [OK] button to display a screen editor on the work window.

■2 Closing screens

(1) Closing a single screen
Either of the following operations closes a screen being edited.

• Select [Screen] → [Close] from the menu.
• Click the [×] button on the title bar on the screen editor.

(2) Closing all screens
Select [Screen] → [Close All] from the menu to close all screens.
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■3 [Open Screen] dialog

1) List of screens
Lists the created base screens, window screens, report screens, and mobile screens.

2) [Number Specification] button
Displays the [Number Specification] dialog.
Specify a screen number to open the corresponding screen.

3) [Specify Image] button
Displays the [Screen Image List] dialog.
You can open a screen by selecting the corresponding screen image.

• [Screen Type]
Select the type of a screen to be opened.

• [Screen No.]
Set the screen number of a screen to be opened.

• [Screen Type]
Select the type of a screen to be opened.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)

Screen image list
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2.6 Basic Operations of the Drawing Screen

The following shows the layout of the screen editor.

1) Screen display area
This area is displayed on the GOT.
Figures and objects can be arranged on this area.
The [+] sign indicates the center of the screen.
On an expanded base screen with its base point at the upper left corner, this sign indicates the center of the GOT 
screen.

2) Blank area
This area is not displayed on the GOT.
Figures and objects cannot be arranged on this area.

3) Temporary area
This area is not displayed on the GOT.
Figures and objects can be temporarily arranged on this area.
The data size of a screen includes the size of the figures and objects arranged on the temporary area.
Before writing package data to the GOT, delete the figures and objects on the temporary area.
The size of the temporary area depends on the screen type.

• Base screen or mobile screen: 3000 dots × 3000 dots
• Window screen, parts editor, or library editor: 2000 dots × 1600 dots
• Report screen: 2048 dots × 2048 dots

The following operations are available for up to 2000 dots × 1600 dots of figures and objects placed on base 
screens or mobile screens.

• Copying a figure or object to a window screen, parts editor, or library editor
• Registering a figure or object as a part
• Registering a figure or object to the library

For how to arrange and set figures and objects, refer to the following.
➟6.5 Placing and Editing Figures and Objects

For the operations of the screen editor, refer to the following.
➟2.6.1 Selecting a screen editor to be edited

2.6.2 Switching the display status of objects to be displayed on the screen editor
2.6.3 Redisplaying a selected screen editor
2.6.4 Setting information to be displayed on the screen editor
2.6.5 Displaying the grid
2.6.6 Displaying the two-point press inactive area
2.6.7 Displaying the scroll bar areas for editing the expanded base screens

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)
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2.6.8 Switching the layer display
2.6.9 Displaying guidelines
2.6.10 Scaling the size of items on the screen editor
2.6.11 Cascading or arranging open screen editors
2.6.12 Copying the image of a screen editor to the clip board

■1 How a figure and an object arranged on the boundary between areas are dealt with.
To display a figure and an object on the GOT, arrange them in the screen display area.
Perform a data check to check if some figures or objects have a part extending to the temporary area.

➟2.11 Performing a Data Check

When figures or objects are arranged on the boundary between the screen display area and temporary area, they are 
displayed on the GOT as described below.

(1) How a figure is displayed
The GOT displays only the part that lies in the screen display area.

(2) How the paint on a figure is displayed
Only when a paint mark is placed in the screen display area, the marked figure is painted.

Displayed on the GOT.

Not displayed on the GOT.

Painting is enabled.

Painting is disabled.
2. CREATING A PROJECT
2.6 Basic Operations of the Drawing Screen

2 - 89



(3) How an object is displayed
The GOT displays only the part that lies in the screen display area.
If the object frame is in the screen display area, it can be displayed on the GOT.

(4) How a superimpose window is displayed
When a window, on which an arranged figure or object extends to the temporary area, is displayed as a superimpose 
window on the GOT, the extending part is displayed on the GOT.
When the superimpose window is hidden, the extending part is left on the base screen.
Switching the base screen updates the screen to remove the left extending part.

Not displayed on the GOT.Object frame

Shape frame Displayed on the GOT.

When the superimpose window is displayed.

Switch is on.

Characters of the object
Shape frame

Superimpose window 1

When the superimpose window is hidden.

Switch is on.

The extending part out of the screen display area is left.
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2.6.1 Selecting a screen editor to be edited

To select a screen editor to be edited, click any part of the screen editor displayed on the work window.
The selected screen editor is displayed at the topmost position.
When multiple screen editors are displayed, the followings are more useful.

■1 Selecting a screen editor with the editor tab
Select a screen editor with the editor tab to display the selected editor at the topmost position.

➟2.2.3 Editor tab, work window

■2 Selecting a screen editor in the [Window Selection] dialog
Step 1 Select [Window] → [Select Windows] from the menu to display the [Window Selection] dialog.

Step 2 Select a screen editor to be edited and click the [OK] button to display the selected editor at the topmost 
position.

2.6.2 Switching the display status of objects to be displayed on the screen editor

■1 Switching the display status between ON and OFF
Select [View] → [ON/OFF Display Switching] from the menu to switch between the on status image and off status image 
of each object on the screen editor.
If a condition is set to an object, the image of the object switches between OFF with the condition No.0 and ON with the 
condition No.1.

■2 Switching the display status by specifying the state No.
Select [View] → [State No.] → [Previous State] or [Next State] from the menu to switch between displaying and hiding 
the objects on the screen editor according to the state No.
If the display status of an object is switched between ON and OFF, the display of the object switches between OFF with 
state No.0 and ON with state No.1 or more.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.6.3 Redisplaying a selected screen editor

When the paint is used for a figure, a part of the figure may be left unpainted.
To display the screen correctly, redisplay the screen editor.

Step 1 Select a screen editor to be redisplayed.
Step 2 Select [View] → [Refresh] from the menu to redisplay the selected screen editor.

Example) When an object on a painted figure is moved

2.6.4 Setting information to be displayed on the screen editor

You can switch between displaying and hiding the following items on the screen editor.
• Device
• Device of label (device assigned to a system label or a label (GT Designer3))
• Object ID
• Paint
• Object
• Object frame
• Template information
• Touch area
• Frame

■1 [Device]
Select [View] → [Display Items] → [Device] from the menu to display or hide devices on the screen editor.

■2 [Device of Label]
Select [View] → [Display Items] → [Device of Label] from the menu to display or hide the devices assigned to system 
labels and labels (GT Designer3) on the screen editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Some area remains unpainted on the figure.An object on a painted figure is moved. To redisplay the object, select [Display] 

→ [Refresh] from the menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
2 - 92 2. CREATING A PROJECT
2.6 Basic Operations of the Drawing Screen



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

■3 [Object ID]
Select [View] → [Display Items] → [Object ID] from the menu to display or hide object IDs on the screen editor.
The object ID is displayed only for objects.

■4 [Paint]
Select [View] → [Display Items] → [Paint] from the menu to display or hide paints on the screen editor.

■5 [Object]
Select [View] → [Display Items] → [Object] from the menu to display or hide objects on the screen editor.

■6 [Object Frame]
Select [View] → [Display Items] → [Object Frame] from the menu to display or hide object frames on the screen editor.

■7 [Template Information]
Select [View] → [Display Items] → [Template Information] from the menu to display or hide the template information on 
the screen editor.

■8 [Touch Area]
Select [View] → [Display Items] → [Touch area] from the menu to display or hide the touch area on the screen editor.
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■9 [Frame]
The item is not displayed for expanded base screens.
Select [View] → [Display Items] → [Frame] from the menu to display or hide the GOT frame on the screen editor.

■10 [Option]
Select [View] → [Display Items] → [Option] from the menu to display the [Option] dialog.
In this dialog, you can configure the settings displayed on the screen editor.

➟11.10.5 ■1 [Options] dialog ([View] tab)
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2.6.5 Displaying the grid

You can display the screen editor with equally-spaced points (a grid) which give an indication to arrange figures and 
objects.
Select [View] → [Grid] → [Front], [Back], or [None] from the menu to display or hide the grid on the screen editor.

2.6.6 Displaying the two-point press inactive area

You can display the two-point press inactive area on the screen editor.
The item is not displayed for expanded base screens.
Select [View] → [Two-point Press Inactive Area] → [Front], [Back], or [None] from the menu to display or hide the two-
point press inactive area on the screen editor.

To enable the two-point touch on the GOT, the touched points must be in different two-point press inactive areas.
Place the points for the two-point touch in different two-point press inactive areas.

➟8.2.3 ■2 (1) Simultaneous 2-point press

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Back][Front] [None]
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2.6.7 Displaying the scroll bar areas for editing the expanded base screens

The following lines are displayable on screen editors.

Example) Displaying an expanded base screen (1600 × 960) on GT27-V (640 × 480)
The scroll bar areas are not displayed because the base screen is vertically and horizontally expanded.

Example) Displaying an expanded base screen (1600 × 480) on GT27-V (640 × 480)
A solid line representing the scroll bar area is displayed in the lower part of the base screen because the screen is 
horizontally expanded.
A scroll bar appears in the scroll bar area when the base screen is displayed on the GOT.

Line type Description

Solid line

Appears when either the vertical or horizontal size of the base screen is larger than the vertical or horizontal 
size of the GOT screen.
Represents the areas of the scroll bars to appear on the GOT.
Appears 40 dots from the right or bottom edge of the screen display area.
Place figures and objects so that they do not overlap the scroll bar areas.

Dotted line

Represents a partition for one GOT screen.
Represents partitions for multiple GOT screens.
The lines are usable as guidelines to specify the size of a base screen to an integral multiple of the GOT 
screen size.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.2

View on the GOT

View on the screen editor

Dotted lines representing partitions for GOT screens

Scroll bar

View on the GOT

View on the screen editor

Scroll barSolid lines representing the scroll bar areas

Scroll bar area

Dotted lines representing partitions for GOT screens
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Select [View] → [Scroll Bar Area] → [Front], [Back], or [None] from the menu to display or hide the lines on the screen 
editors.

In the following cases, no scroll bar is displayed on the GOT, and no lines representing the scroll bar areas and partitions 
for GOT screens are displayed on the screen editors.

• The base screen is smaller than the GOT screen.
• The scroll bars are set to be hidden.

For details on the base screen size expansion, refer to the following.
➟5.1.3 Base screen size expansion ([Expand base screen sizes])

2.6.8 Switching the layer display

Select [View] → [Layer] → [All screens], [Front], [Back], or [Front+Back] from the menu to switch the layers to be 
displayed.

• [All screens]
Switches between all screen editors and individual screen editor as the target for the layer switching.

• [Front], [Back], [Front+Back]
Switches the layers to be displayed.

[Back][Front] [None]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Front and Back][Back][Front]
2. CREATING A PROJECT
2.6 Basic Operations of the Drawing Screen

2 - 97



2.6.9 Displaying guidelines

When moving a figure or object, you can display guidelines to indicate a position relation between other figures and 
objects.

Select [View] → [Guidelines (auxiliary line)] → [Display], [Shape], [Object], [Shape+Object], [Same Type], or [Custom] 
from the menu to change the display of guidelines.

• [Display]
Displays or hides guidelines.

• [Figure]
Displays guidelines in relation to existing figures.

• [Object]
Displays guidelines in relation to existing objects.

• [Figure and Object]
Displays guidelines in relation to existing figures and objects.

• [Same Type]
Displays guidelines in relation to the same type of existing figures or objects as those being moved.

• [Custom]
[Displays the Guidelines (auxiliary line)] dialog. 
You can customize guidelines such as where they are displayed.

➟■1 [Guidelines (auxiliary line) setting] dialog

(1) Guidelines displayed for grouped figures or objects
When you group figures or objects, the guidelines are displayed for the figure or object group.

(2) Cases in which guidelines are not displayed
Guidelines are not displayed in the following cases.
• In the touch area of a touch switch
• When performing operations with a keyboard

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Guidelines
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■1 [Guidelines (auxiliary line) setting] dialog

1) [Line Display]
Set where to display guidelines.

2) [Display Target]
Select targets for guidelines.

• [Figure]
Displays guidelines in relation to existing figures.

• [Object]
Displays guidelines in relation to existing objects.

• [Figure and Object]
Displays guidelines in relation to existing figures and objects.

• [Same Type]
Displays guidelines in relation to the same type of existing figures or objects as those being selected.

3) [Display Application Range]
A figure or object can be automatically in alignment with an existing figure or object. Select the distance (in dot) 
between a figure/object to be moved and existing figures/objects.
The available value is [0], [2], [4], and [8].
Moving an existing figure or object while pressing the [Alt] key disables the setting for [Display Application Range].
Example) Correcting a vertical position

• [Display Application Range]: [8]
Drag the figure or object, which should be vertically aligned, within 8 dots from the target for the alignment.
Doing so horizontally aligns the figure or object being moved with the target figure or object.

Item Description

[Left], [Right], [Center of Width], [Center of 
Height], [Up], [Down]

Set the position of guidelines displayed on a figure or an object being moved. 
Select each item to display the image of corresponding guideline in the [Guidelines 
(auxiliary line)] dialog.

[Show guidelines on the boundaries between 
the center of screen and temporary area]

Displays the guidelines at the center of the screen ([+]) and the boundary of the temporary 
area.

[Borders of Table] Displays the guidelines for table borders.

[Scroll Bar Area]
Displays the guidelines for the following items on the expanded base screens.
• Solid lines representing the scroll bar areas
• Dotted lines representing partitions for GOT screens

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Before correction (away more than 8 dots) After correction (moved within 8 dots)
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2.6.10 Scaling the size of items on the screen editor

Select [View] → [Zoom] → one of the following items from the menu to change the display magnification of the screen 
editor.

• [All Screens]
Applies a specified display magnification to all screen editors.

• [400%], [300%], [200%], [150%], [100%], [75%], [50%], [25%]
Changes the display magnification of the screen editor to the selected magnification.

• [Custom]
Displays the [Zoom] dialog.
The display magnification of the screen editor is customizable.

➟■1 [Zoom] dialog
• [Whole Screen]

Resizes the screen display area of the screen editor according to the editor window size.
This item is not selectable when [All Screens] is selected.

■1 [Zoom] dialog

1) [All screens]
Applies the display magnification setting to all screen editors.

2) Display magnification
Select the display magnification of a selected screen editor.

3) Custom magnification
Specify the display magnification in units of 1%.
The setting range is [25] to [400].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.6.11 Cascading or arranging open screen editors

Select [Window] → [Cascade], [Arrange Sideways], or [Arrange Lengthways] from the menu to cascade or arrange 
screen editors and windows which are displayed on the work window.

2.6.12 Copying the image of a screen editor to the clip board

Select [Screen] → [Copy Screen Image to the Clipboard] from the menu to copy the image of a screen editor being edited 
to the clip board.
Only the image within the screen display area is copied.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Arrange Lengthways][Arrange Sideways][Cascade]
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2.7 Changing Screen Property

You can change the screen properties including the screen number, background color, and the key window setting that 
can be enabled per screen.

➟2.7.1 Property of base screens
2.7.2 Properties of window screens
2.7.3 Property of report screens

For information on how to set the mobile screen properties, refer to the following.
➟10.19.7 Mobile screen properties

2.7.1 Property of base screens

Step 1 By either of the following operations, select a base screen whose screen property is to be changed.
• Clicking any part of the screen editor
• Selecting a screen in the [Screen] window

(If you select multiple screens with the [Ctrl] key or [Shift] key, you can change the properties of the screens 
at a time.)

➟2.2.4 ■3 [Screen] window
Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog (for base 

screen).

➟■1 [Basic] tab
■2 [Key Window Basic Setting] tab
■3 [Key Window Advanced Setting] tab
■4 [Dialog Window] tab
■5 [Option Selection Window] tab

Step 3 Click the [OK] button after the required settings to reflect the setting.
When you select multiple screens in the [Screen] tree, the settings are reflected to all the selected screens.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Basic] tab

1) [Screen No.]
Set a screen number.
The setting range is [0] to [32767].
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be changed.

2) [Title]
Set the title of the screen.
Up to 32 characters can be set.

3) [Screen Type]
Displays the screen type.

4) [Detailed Description]
Set the explanation for the screen.
Up to 512 characters can be set.
A line feed is counted as two characters.

5) [Security]
Set the security level.
The setting range is [0] to [15].
If you do not use the security function of the GOT, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
6) [Screen Size] button

Available to GT27, GT25, and GS25.

This item is available when [Expand base screen sizes] is selected in [Basic Setting] in the [Type Setting] dialog.
The [Change Base Screen Size] dialog appears.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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You can enter values to change the base screen size.

7) [Front Layer Transparent]
Not available to GT21 and GS21.

Set the transparent color of the object arranged on the front layer.
➟6.5.5 ■3 (2) Using layers

The parts of the objects whose colors are set to the transparent color become transparent, and the back layer can 
be seen through them.

➟6.4.2 Color settings
8) [Individually set the screen design]

Enables the individual screen design (including the background color), instead of the design selected in the [Screen 
Design] dialog.

9) [Background Color]

Select a background color.
For the color setting, refer to the following.

➟6.4.2 Color settings

Select a background color, pattern, and pattern color for the screen.
The pattern is displayed on the background color.

For the color setting, refer to the following.
➟6.4.2 Color settings

10) [Switch Station No.]
Enables the station No. switching by screen.

➟5.5.4 Configuring the settings for switching the target station No. for monitoring

• [X Range]
Setting range of the horizontal size

• [X]
Set the horizontal size (dot).

• [Y Range]
Setting range of the vertical size

• [Y]
Set the vertical size (dot).

• [Edit] button
This button is not displayed when the screen is newly created.
Changes the size of window screens on the screen editor.

Change the screen size and click any part other than the handles to 
confirm the change.

Drag the handles to change the screen size.

GOT Graphic Ver.1

GOT Graphic Ver.2

GOT Graphic Ver.1

Pattern + Pattern color

Background Color

Example)

Pattern
Pattern color :

:

Background Color :
2 - 104 2. CREATING A PROJECT
2.7 Changing Screen Property



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

11) [Switch buffer memory unit No.]
Enables the buffer memory unit No. switching by screen.

➟5.5.5 Configuring the settings for switching the buffer memory unit No. of the monitoring target
12) [Pop up alarms]

An alarm pops up when an alarm occurs.

Configure the following settings additionally.
• User alarm settings or system alarm settings

➟9.1.2 ■7 [User Alarm Observation] dialog
9.1.3 ■5 [System Alarm Observation] dialog

• Alarm popup display setting
➟9.1.4 ■4 [Alarm Popup Display] dialog

13) [Target for exclusive control of operational authority]
Not available to GT21 and GS21.
Enables the authorization control for the base screen.

➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])
14) [Screen Gesture Inactive Area]

Only available to GT27.
This item is not available when [Expand base screen sizes] is selected in [Basic Setting] in the [Type Setting] dialog.
Set an area (screen gesture inactive area) where object operations are enabled even in the screen gesture mode.

➟11.12.1 ■1 Screen gesture mode

Item Description

[Display Position]

Select the position to display an alarm to be popped up.
The following shows the items to be selected.
• [Up]
• [Center]
• [Down]

Item Description

[Position]

Select a position to arrange the screen gesture inactive area.
The following shows the items to be selected.
• [Top]: Specifies the area from the top edge of the base screen to the position specified 

with [Size].
• [Bottom]: Specifies the area from the bottom edge of the base screen to the position 

specified with [Size].

[Size]
Set the height of the screen gesture inactive area.
The setting range is [16] dots to [100] dots.

[Display the screen gesture inactive area]

Displays the box indicating the screen gesture inactive area on the screen editor.
Arrange the switch for switching to the screen gesture mode in the screen gesture inactive 
area.

➟11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen Gesture Function)

Screen gesture inactive area
2. CREATING A PROJECT
2.7 Changing Screen Property

2 - 105



15) [Backlight Color]
Only available to GT21-P.
Set whether to blink the backlight.
The following shows the items to be selected.

• [White]
• [Green]
• [Red]
• [Pink]
• [Orange]

16) [Blink Backlight]
Only available to GT21-P.
The following shows the items to be selected.

• [None]
• [Blink]

■2 [Key Window Basic Setting] tab

The following shows the basic settings of key windows for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.4 ■4 [Key Window]

1) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window 
Setting] for each screen.

2) [Key Window]
Select the type of a key window to be used.
The following shows the items to be selected.

• [Standard]
Uses the standard key window pre-installed in the GOT.

• [User-created (individual setting)]
Uses the standard key window or the user-created key window.
Set the key window to be used in [Individual Setting].

3) [Individual Setting]
Set the key window to be used for each input target.

Item Description

[Change display screen in conjunction with 
Language Switching]

Changes the key windows to be used in conjunction with the value of the language 
switching device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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[Language]

Select the value of the language switching device.
The setting range is [1] to [30].

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
For each value of the language switching device, you can set a key window to be used.
If you select [User-created] in [Key Window Type], [*] is added to the value of the selected 
range.
Example)
• If the value of the language switching device is 1, the standard key window is used for 

text input.
• If the value of the language switching device is 2, the user-created key window is used 

for text input.

[Key Window] The use of each key window

[Key Window Type]

Select the type of key windows according to their uses.
The following shows the items to be selected.
• [Standard]

Uses the standard key window.
• [User-created]

Uses the created window screen as a key window.
Set the window screen to be used in [Window Screen No.].

[Window Screen No.]

If you select [User-created] in [Key Window Type], set the window screen number to be 
displayed as a key window.
Click the [...] button to display the [Screen Image List] dialog.
You can check the image on the screen when selecting a window screen.

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the screen in the screen 
image list.

Item Description

Select [2] for [Language] and select [User-created] for 

[Key Window Type] in [Text].

Select [1] for [Language] and select [Standard] for 

[Key Window Type] in [Text].

Screen image list

Jump
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4) [Display the standard key window for text]
Not available to GT21 and GS21.
Uses the standard key window for text input.

5) [Prioritize screen setting over project setting]
Not available to GT21 and GS21.
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window Type] 
for each screen.

■3 [Key Window Advanced Setting] tab

The following shows the advanced settings of key windows for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.4 ■4 (2) [Advanced Setting] tab

[Number of used screens]

This can be set only to [Text].
Set the number of key windows used for text input.
With the window screen set in [Window Screen No.] as the first on the list, window screens 
are used for the set number as key windows.
To switch key windows, arrange key code switches to which the following operations are 
set.
• [Window Screen Switching for Text (next)]
• [Window Screen Switching for Text (previous)]
• [Window Screen Switching for Text (specified screen No.)]

➟8.2.11 [Key Code Switch] dialog

Item Description

[Display value during input]

Displays the value being input in the key window.
To display the value in the user-created key window, arrange the input value area setting 
on the window screen.

➟8.31 Placing an Object to Display the Input Information

[Display previous value]

Displays the previous value in the key window.
To display the previous value in the user-created key window, arrange the previous value 
area setting on the window screen.

➟8.31 Placing an Object to Display the Input Information

[Display input function range]

Displays the valid input range in the key window.
To display the valid input range in the user-created key window, arrange the input range 
area setting on the window screen.

➟8.31 Placing an Object to Display the Input Information

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window/
Cursor Display Setting] for each screen.

2) [When operating conditions are satisfied]
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are satisfied.

3) [When screens are switched]
Configure the display settings of the key window and cursor to switch screens for when the operating conditions of 
the object for input are satisfied.

4) [When operating conditions are not satisfied]
Not available to GT21 and GS21.
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are not satisfied.

Item Description

[Key Window]

Configure the display settings of the key window for when the operating conditions of the 
objects for input are satisfied.
The following shows the items to be selected.
• [Display at any time] (Not available to GT21 and GS21)
• [Display when touched]
• [Hide]

[Cursor]

Not available to GT21 and GS21.
Configure the display settings of the cursor for when the operating conditions of the object 
for input are satisfied.
The following shows the items to be selected.
• [Display at any time]
• [Display when touched]

Item Description

[Display the key window] Displays a key window when the screen is switched.

[Display the cursor]
Displays a cursor when the screen is switched.
Set the position to display the cursor in [Cursor Position].

[Cursor Position]

Select the position to display the cursor when the screen is switched.
The following shows the items to be selected.
• [Upper left]

Displays the cursor at the object nearest to the upper left corner of the screen.
• [User ID minimum]

Displays the cursor at the object with the smallest user ID.
• [User ID specification]

Displays the cursor at the object with the specified user ID.
Set the user ID of the object on which the cursor is displayed in [User ID].

[User ID]
Sets the user ID of the object on which the cursor is displayed.
The setting range is [1] to [65535].

Item Description

[Clear the key window and the cursor] Deletes the key window and cursor when the operating conditions of the objects for input 
are not satisfied.

[Clear the input object] Deletes the key window, the cursor, and the objects for input when the operating conditions 
of the objects for input are not satisfied.
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5) [Key Window Advanced Setting]
Click the [Setting] button to display the [Display Detail Setting] dialog.

6) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window/
Cursor Movement] for each screen.

7) [Defined key action]
Select the action of the key window and cursor when the enter key is touched.
The following shows the items to be selected.

• [Clear the key window and the cursor]
Deletes the key window and cursor.

• [Control the cursor]
Moves the cursor to the specified position.
Select a position to move the cursor in [Cursor Move Destination].

8) [Cursor Move Destination]
Select a position to move the cursor.
The following shows the items to be selected.

• [Cursor Type]
Select the action of the cursor to be displayed on the input area.
• [1-character blink]

Blinks the area for one character in the input area.
• [Highlight all + 1-character blink]

Highlights the characters displayed in the input area, and blinks 
the area for one character.

• [Display the cursor with a touch on the Enter/arrow key when 
the cursor is hidden]
Not available to GT21 and GS21.
Displays the cursor when the enter key or an arrow key is touched 
while the cursor is hidden.

• [Display the valid input range when an invalid value is input in 
Numerical Input]
Not available to GT21 and GS21.
Displays the dialog indicating the valid input range when an invalid 
value is input in numerical input.

• [Display the input confirmation dialog when setting the function 
of Numerical/Text Input]
Displays the confirmation dialog when numerical values or text are 
input.

• [Check the input range while entering numerical values]
Not available to GT21 and GS21.
This item is enabled only when an input range is set.
The error message is displayed when a value out of the setting 
range is being entered.
➟8.4.5 ■3 [Input case] tab

• [Display the title bar on the user-created key window]
Not available to GT2104-P and GT2103-P.
Displays the title bar of a user-created key window.
For the precautions on hiding the title bar, refer to the following.
➟5.2.4 ■3 (2) Setting to close the key window whose title bar is 
hidden

Item Description

[Same operation as the right arrow key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

Object A

Object B Object C

Object D

1

2

3 1

2

3
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9) [When the cursor cannot shift]

This item is displayed when [Cursor Move Destination] is set to [In order of user ID] or [Subsequently valid user ID].
Select how the cursor moves when no destination object exists.
The following shows the items to be selected.

• [Not move]
• [Clear]

10) [Reference for determining cursor destination]
Select the standard to determine a position to move the cursor.
The following shows the items to be selected.

• [Upper left]
• [Lower right]

11) [Key Window Position Correction]
Select an action of the key window when it overlaps the input target object.
The following shows the items to be selected.

• [Not move]

[Same operation as the down arrow 
key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

[In order of user ID]

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.
If the destination object is hidden due to unsatisfied conditions, the cursor does not move.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[Subsequently valid user ID]
(Not available to GT21 and GS21)

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.
If the destination object is hidden due to unsatisfied conditions, the cursor moves to the object 
specified with [Move Destination ID] of the hidden destination object.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[Not move] Does not move the cursor even after the entry is confirmed.

Item Description

Object A
Object B

Object C
Object D

1 2 3

12 3

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object D
・[User ID]: 4
・[Move Destination ID]: 5

Object C
・[User ID]: 3
・[Move Destination ID]: 4

The cursor does not move to this object 
because the object is hidden due to unsatisfied conditions.

The cursor moves to this object.

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object C
・[User ID]: 3
・[Move Destination ID]: 4

Object D
・[User ID]: 4
・[Move Destination ID]: 5

The cursor does not move 
to this object because the object 
is hidden due to unsatisfied conditions.
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Keeps the key window displayed even if it overlaps the input target object.
• [To the four corners of the screen]

Displays the key window at one of the four corners so that it does not overlap the input target object.
Displays the key window on the lower right of the screen if it overlaps the input target object wherever it is.

• [Around the object]
Displays the key window according to the position of the input target object.

■4 [Dialog Window] tab

The following shows the settings of the dialog window for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.3 ■4 [Dialog Window...]

1) [Prioritize screen setting over project setting]
Prioritizes the settings of [Dialog Window] in the [Screen Property] dialog over the settings for each project in the 
[Environmental Setting] window.

2) [System message to be replaced in Dialog Window]
Select a system message to be replaced by the dialog window.
Replaces the selected system message with the window screen set in [Window Screen No.].
The following shows the items to be selected.

• [Input Digits Overflow (Integer Part)]
• [Input Digits Overflow (Decimal Part)]
• [Input Condition Failure]
• [Input Digits Overflow]
• [Out of Input Range]
• [Input Confirmation]
• [Barcode/RFID Data invalid]

For the system messages of each item, refer to the following.
➟5.2.3 ■2 How to use dialog windows

3) [Window Screen No.]
Set a screen number of the window screen to be displayed instead of the system message.
The setting range is [0] to [32767].
Click the [Browse] button to display the [Screen Image List] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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You can check the image on the screen when selecting a window screen.

4) [Screen Switching] button
Displays the [Environmental Setting] dialog.

➟5.2.3 ■4 [Dialog Window...]
5) [Dialog window Switching Device]

The currently set screen switching device for a dialog window

■5 [Option Selection Window] tab

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings in the option selection window. The settings are used at Kana-Kanji conversion or Pinyin 
conversion for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.13 ■4 [Kana-Kanji/Pinyin Conversion]

1) [Prioritize screen setting over project setting]
Prioritizes the settings of [Option Selection Window] in the [Screen Property] dialog over the settings for each 
project in the [Environmental Setting] window.

2) [Use the option selection window]

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

Screen image list

Jump

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Select this item to display the option selection window when converting kana characters to kanji characters or Pinyin 
characters to Simplified Chinese characters.

3) [Background Color]
Select the background color of the option selection window.

4) [Scroll]
Select the key to be displayed in the option selection window.

• [Page + Line Scroll]: Displays the key to scroll the screen by page and line.
• [Page Scroll]: Displays the key to scroll the screen by page.

5) [Preview]
Displays the preview of the option selection window which the settings of [Background Color] and [Scroll] are 
reflected.

2.7.2 Properties of window screens

Step 1 By either of the following operations, select a window screen whose properties are to be changed.
• Clicking any part of the screen editor
• Selecting a screen in the [Screen] window

(If you select multiple screens with the [Ctrl] key or [Shift] key, you can change the properties of the screens 
at a time.)

➟2.2.4 ■3 [Screen] window
Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog (for window 

screen).

➟■1 [Basic] tab
■2 [Key Window Basic Setting] tab
■3 [Key Window Advanced Setting] tab
■4 [Dialog Window] tab
■5 [Option Selection Window] tab

Step 3 Click the [OK] button after the required settings to reflect the setting.
When you select multiple screens in the [Screen] tree, the settings are reflected to all the selected screens.

■1 [Basic] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Screen No.]
Set a screen number.
The setting range is [0] to [32767].
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be changed.

2) [Title]
Set the title of the screen.
Up to 32 characters can be set.

3) [Screen Type]
Displays the screen type.

4) [Detailed Description]
Set the explanation for the screen.
Up to 512 characters can be set.
A line feed is counted as two characters.

5) [Security]
Set the security level.
The setting range is [0] to [15].
If you do not use the security function of the GOT, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
6) [Front Layer Transparent]

Not available to GT23, GT21, and GS21.

Set the transparent color of the object arranged on the front layer.
➟6.5.5 ■3 (2) Using layers

The parts of the objects whose colors are set to the transparent color become transparent, and the back layer can 
be seen through them.

➟6.4.2 Color settings
7) [Screen Size] button

Displays the [Change Window Size] dialog.
Specify a numerical value to change the size of the window screen.

• [X Range]
Setting range of the horizontal size

• [X]
Set the horizontal size (dot).

• [Y Range]
Setting range of the vertical size

• [Y]
Set the vertical size (dot).

• [Edit] button
This button is not displayed when the screen is newly created.
Changes the size of window screens on the screen editor.

Change the screen size and click any part other than the handles to 
confirm the change.

GOT Graphic Ver.1

Drag the handles to change the screen size.
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8) [Individually set the screen design]
Enables the individual screen design (including the background color), instead of the design selected in the [Screen 
Design] dialog.

9) [Background Color]

Select a background color.
For the color setting, refer to the following.

➟6.4.2 Color settings
For a window screen, if [Screen Contour] is set to [Rounded], the gradient area of the window screen varies 
depending on whether its title bar is displayed.
Position the window screen on the screen editor of the base screen, and check the window screen image in the 
[Screen Preview] window.

➟2.9.1 Displaying a preview

Select a background color, pattern, and pattern color for the screen.
The pattern is displayed on the background color.

For the color setting, refer to the following.
➟6.4.2 Color settings

10) [Transparency]

Set the transparency of the window screen.
The setting range is [0]% to [100]%.

11) [Screen Contour]

Set the contours of the window screen.
The following shows the items to be selected.

• [Rectangle]
• [Rounded]

12) [Radius]

When [Rounded] is selected for [Screen Contour], set the circle radius.
The following shows the items to be selected.
[0] dots to (n - 1) / 2 dots
n: Window screen height or width, whichever is smaller (dots)
The fractional portion of the result is rounded off.

13) [Switch Station No.]
Enables each screen to swtich station No.

➟5.5.4 Configuring the settings for switching the target station No. for monitoring
14) [Switch buffer memory unit No.]

Enables the buffer memory unit No. switching by screen.
➟5.5.5 Configuring the settings for switching the buffer memory unit No. of the monitoring target

15) [Target for exclusive control of operational authority]
Not available to GT21 and GS21.
Enables the authorization control for the base screen.

➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])

GOT Graphic Ver.2

GOT Graphic Ver.1

Pattern + Pattern color

Background Color

Example)

Pattern

Pattern color :

:

Background Color :

GOT Graphic Ver.2

GOT Graphic Ver.2

GOT Graphic Ver.2
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■2 [Key Window Basic Setting] tab

The following shows the basic settings of key windows for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.4 ■4 (1) [Basic] tab

1) [Key Window Setting]
Type settings of the key window to be used

2) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window 
Setting] for each screen.

3) [Key Window Setting]
Select the type of a key window to be used.
The following shows the items to be selected.

• [Standard Key Window]
Uses the standard key window pre-installed in the GOT.

• [User-created screen Key window (individual)]
Uses the standard key window or the user-created key window.
Set the key window to be used in [Individual Setting].

4) [Individual Setting]
Set the key window to be used for each input target.

Item Description

[Change display screen in conjunction with 
Language Switching]

Changes the key windows to be used in conjunction with the value of the language 
switching device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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[Language]

Select the value of the language switching device.
The setting range is [1] to [30].
For each value of the language switching device, you can set a key window to be used.
If you select [User-created] in [Key Window Type], [*] is added to the value of the selected 
range.
Example)
• If the value of the language switching device is 1, the standard key window is used for 

text input.
• If the value of the language switching device is 2, the user-created key window is used 

for text input.

[Key Window] The use of each key window

[Key Window Type]

Select the type of key windows according to their uses.
The following shows the items to be selected.
• [Standard]

Uses the standard key window.
• [User-created]

Uses the created window screen as a key window.
Set the window screen to be used in [Window Screen No.].

[Window Screen No.]

If you select [User-created] in [Key Window Type], set the window screen number to be 
displayed as a key window.
Click the [...] button to display the [Screen Image List] dialog.
You can check the image on the screen when selecting a window screen.

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the screen in the screen 
image list.

Item Description

Select [2] for [Language] and select [User-created] for 

[Key Window Type] in [Text].

Select [1] for [Language] and select [Standard] for 

[Key Window Type] in [Text].

Screen image list

Jump
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5) [Display the standard key window for text]
Not available to GT21 and GS21.
Uses the standard key window for text input.

6) [Key Window Type]
Not available to GT21 and GS21.
Settings of the information displayed on the key window.

7) [Prioritize screen setting over project setting]
Not available to GT21 and GS21.
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window Type] 
for each screen.

[Used Screen No.]

This can be set only to [Text].
Set the number of key windows used for text input.
With the window screen set in [Window Screen No.] as the first on the list, window screens 
are used for the set number as key windows.
To switch key windows, arrange key code switches to which the following operations are 
set.
• [Window Screen Switching for Text (next)]
• [Window Screen Switching for Text (previous)]
• [Window Screen Switching for Text (specified screen No.)]

➟8.2.11 [Key Code Switch] dialog

Item Description

[Display value during input]

Displays the value being input in the key window.
To display the value in the user-created key window, arrange the input value area setting 
on the window screen.

➟8.31 Placing an Object to Display the Input Information

[Display previous value]

Displays the previous value in the key window.
To display the previous value in the user-created key window, arrange the previous value 
area setting on the window screen.

➟8.31 Placing an Object to Display the Input Information

[Display input function range]

Displays the valid input range in the key window.
To display the valid input range in the user-created key window, arrange the input range 
area setting on the window screen.

➟8.31 Placing an Object to Display the Input Information

Item Description
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■3 [Key Window Advanced Setting] tab

The following shows the advanced settings of key windows for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.4 ■4 (2) [Advanced Setting] tab

1) [Key Window Display Setting]
Display settings of the key window and cursor

2) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window/
Cursor Display Setting] for each screen.

3) [When operating conditions are satisfied]
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are satisfied.

4) [When screens are switched]
Configure the display settings of the key window and cursor to switch screens for when the operating conditions of 
the object for input are satisfied.

Item Description

[Key Window]

Configure the display settings of the key window for when the operating conditions of the 
objects for input are satisfied.
The following shows the items to be selected.
• [Display at any time] (Not available to GT21 and GS21)
• [Display when touched]
• [Hide]

[Cursor]

Not available to GT21 and GS21.
Configure the display settings of the cursor for when the operating conditions of the object 
for input are satisfied.
The following shows the items to be selected.
• [Display at any time]
• [Display when touched]

Item Description

[Display the key window] Displays a key window when the screen is switched.

[Display the cursor]
Displays a cursor when the screen is switched.
Set the position to display the cursor in [Cursor Position].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

8)

10)

12)

3)

5)
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1)
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5) [When operating conditions are not satisfied]
Not available to GT21 and GS21.
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are not satisfied.

6) [Key Window Advanced Setting]
Click the [Setting] button to display the [Display Detail Setting] dialog.

7) [Prioritize screen setting over project setting]
Does not apply the settings made in the [Environmental Setting] window, and enables setting in [Key Window/
Cursor Movement] for each screen.

8) [Defined key action]
Set the action of the key window and cursor when the enter key is touched.
The following shows the items to be selected.

• [Clear the key window and the cursor]
Deletes the key window and cursor.

• [Control the cursor]
Deletes the key window and cursor.

[Cursor Position]

Select the position to display the cursor when the screen is switched.
The following shows the items to be selected.
• [Upper left]

Displays the cursor at the object nearest to the upper left corner of the screen.
• [User ID minimum]

Displays the cursor at the object with the smallest user ID.
• [User ID specification]

Displays the cursor at the object with the specified user ID.
Set the user ID of the object on which the cursor is displayed in [User ID].

[User ID]
Sets the user ID of the object on which the cursor is displayed.
The setting range is [1] to [65535].

Item Description

[Clear the key window and the cursor] Deletes the key window and cursor when the operating conditions of the objects for input 
are not satisfied.

[Clear the input object] Deletes the key window, the cursor, and the objects for input when the operating conditions 
of the objects for input are not satisfied.

• [Cursor Type]
Select the action of the cursor to be displayed on the input area.
• [1-character blink]

Blinks the area for one character in the input area.
• [Highlight all + 1-character blink]

Highlights the characters displayed in the input area, and blinks 
the area for one character.

• [Display the cursor with a touch on the Enter/arrow key when 
the cursor is hidden]
Not available to GT21 and GS21.
Displays the cursor when the enter key or an arrow key is touched 
while the cursor is hidden.

• [Display the valid input range when an invalid value is input in 
Numerical Input]
Not available to GT21 and GS21.
Displays the dialog indicating the valid input range when an invalid 
value is input in numerical input.

• [Display the input confirmation dialog when setting the function 
of Numerical/Text Input]
Displays the confirmation dialog when numerical values or text are 
input.

• [Check the input range while entering numerical values]
Not available to GT21 and GS21.
This item is enabled only when an input range is set.
The error message is displayed when a value out of the setting 
range is being entered.
➟8.4.5 ■3 [Input case] tab

• [Display the title bar on the user-created key window]
Not available to GT2104-P and GT2103-P.
Displays the title bar of a user-created key window.
For the precautions on hiding the title bar, refer to the following.
➟5.2.4 ■3 (2) Setting to close the key window whose title bar is 
hidden

Item Description
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Select a position to move the cursor in [Cursor Move Destination].
9) [Cursor Move Destination]

Select a position to move the cursor.
The following shows the items to be selected.

Item Description

[Same operation as the right arrow key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

[Same operation as the down arrow 
key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

[In order of user ID]

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.
If the destination object is hidden due to unsatisfied conditions, the cursor does not move.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[Subsequently valid user ID]
(Not available to GT21 and GS21)

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.
If the destination object is hidden due to unsatisfied conditions, the cursor moves to the object 
specified with [Move Destination ID] of the hidden destination object.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[In order of user ID] Does not move the cursor even after the entry is confirmed.

Object A

Object B Object C

Object D

1

2

3 1

2

3

Object A
Object B

Object C
Object D

1 2 3

12 3

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object D
・[User ID]: 4
・[Move Destination ID]: 5

Object C
・[User ID]: 3
・[Move Destination ID]: 4

The cursor does not move to this object 
because the object is hidden due to unsatisfied conditions.

The cursor moves to this object.

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object C
・[User ID]: 3
・[Move Destination ID]: 4

Object D
・[User ID]: 4
・[Move Destination ID]: 5

The cursor does not move 
to this object because the object 
is hidden due to unsatisfied conditions.
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10) [When the cursor cannot shift]
This item is displayed when [Cursor Move Destination] is set to [In order of user ID] or [Subsequently valid user ID].
Select how the cursor moves when no destination object exists.

• [Not move]
• [Clear]

11) [Reference for determining cursor destination]
Select the standard to determine a position to move the cursor.
The following shows the items to be selected.

• [Upper left]
• [Lower right]

12) [Key Window Position Correction]
Set the action of the key window when it overlaps the input target object.
The following shows the items to be selected.

• [Not move]
Keeps the key window displayed even if it overlaps the input target object.

• [To the four corners of the screen]
Displays the key window at one of the four corners so that it does not overlap the input target object.
Displays the key window on the lower right of the screen if it overlaps the input target object wherever it is.

• [Around the object]
Displays the key window according to the position of the input target object.

■4 [Dialog Window] tab

The following shows the settings of the dialog window for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.3 ■4 [Dialog Window...]

1) [Prioritize screen setting over project setting]
Prioritizes the settings of [Dialog Window] in the [Screen Property] dialog over the settings for each project in the 
[Environmental Setting] window.

2) [System message to be replaced in Dialog Window]
Select a system message to be replaced by the dialog window.
Replaces the selected system message with the window screen set in [Window Screen No.].
The following shows the items to be selected.

• [Input Digits Overflow (Integer Part)]
• [Input Digits Overflow (Decimal Part)]
• [Input Condition Failure]
• [Input Digits Overflow]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

4)
5)

1)

3)
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• [Out of Input Range]
• [Input Confirmation]
• [Barcode/RFID Data invalid]

For the system messages of each item, refer to the following.
➟5.2.3 ■2 How to use dialog windows

3) [Window Screen No.]
Set a screen number of the window screen to be displayed instead of the system message.
The setting range is [0] to [32767].
Click the [Browse] button to display the [Screen Image List] dialog.
You can check the image on the screen when selecting a window screen.

4) [Screen Switching] button
Displays the [Environmental Setting] dialog.

➟5.2.3 ■4 [Dialog Window...]
5) [Dialog window Switching Device]

The currently set screen switching device for a dialog window

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

Screen image list

Jump
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■5 [Option Selection Window] tab

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Configure the settings in the option selection window. The settings are used at Kana-Kanji conversion or Pinyin 
conversion for each screen.
For the settings for each project, configure the settings in the [Environmental Setting] window.

➟5.2.13 ■4 [Kana-Kanji/Pinyin Conversion]

1) [Prioritize screen setting over project setting]
Prioritizes the settings of [Option Selection Window] in the [Screen Property] dialog over the settings for each 
project in the [Environmental Setting] window.

2) [Use the option selection window]
Select this item to display the option selection window when converting kana characters to kanji characters or Pinyin 
characters to Simplified Chinese characters.

3) [Background Color]
Select the background color of the option selection window.

4) [Scroll]
Select the key to be displayed in the option selection window.

• [Page + Line Scroll]: Displays the key to scroll the screen by page and line.
• [Page Scroll]: Displays the key to scroll the screen by page.

5) [Preview]
Displays the preview of the option selection window which the settings of [Background Color] and [Scroll] are 
reflected.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

2)
3)
4)
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2.7.3 Property of report screens

Step 1 By either of the following operations, select a report screen whose screen property is to be changed.
• Clicking any part of the screen editor
• Selecting a screen in the [Screen] window

(If you select multiple screens with the [Ctrl] key or [Shift] key, you can change the properties of the screens 
at a time.)

➟2.2.4 ■3 [Screen] window
Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog (for report 

screen).

➟■1 [Basic] tab
■2 [Action] tab
■3 [Format] tab
■4 [File Save] tab

Step 3 Click the [OK] button after the required settings to reflect the setting.
When you select multiple screens in the [Screen] tree, the settings are reflected to all the selected screens.

■1 [Basic] tab

1) [Screen No.]
Set a screen number.
The setting range is [1] to [99].
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be changed.

2) [Screen Name]
Set the title of the screen.
Up to 32 characters can be set.

3) [Screen Type]
Displays the screen type.

4) [Detailed Description]
Set the explanation for the screen.
Up to 512 characters can be set.
A line feed is counted as two characters.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [Action] tab

1) [Output Destination]
Set the destination to which a report is output.
The following shows selectable items.

• [Printer]
• [File] (GT27, GT25, GT23, and GS25)

2) [Output Timing]
Set the timing for outputting data to a report.
The following shows selectable items.

• [At the time of data collection]
This item appears when [Printer Type] is set to [Serial] in the [Printer] dialog.

➟10.11.8 [Printer] dialog
Outputs the collected data to a report simultaneously with data collection.

• [When trigger condition is satisfied]
Stores the collected data into a temporary file, and collectively outputs the data to a report when the output 
trigger condition is satisfied.

• [When one page's worth of data is collected] (GT21 and GS21)
This item appears when [Printer Type] is set to [PCL5] in the [Printer] dialog.

➟10.11.8 [Printer] dialog
Outputs data to a report when one page's worth of data has been collected.

3) [Collection Setting]

Item Description

[Collection Trigger]

This item appears when [Repeat] is included in [Output Target].
The following shows selectable items.
• [Rise]

Collects the data at the rise of the bit device.
Specify a bit device.

• [Fall]
Collects the data at the fall of the bit device.
Specify a bit device.

• [Sampling]
This item is selectable when [Output Timing] is set to [When trigger condition is satisfied].
Collects the data at a constant period.
The setting range is [3] to [3600] seconds.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

When [Output Destination] is set to [File]

2)

3)

4)

5)

When [Output Destination] is set to [Printer]
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4) [Output Setting]

5) [Detail Setting]
Configure the process notification device settings and detailed settings for temporary files.

[Delete Trigger]

This item appears when [Output Timing] is set to [When trigger condition is satisfied].
Select this item to use the trigger that clears the data stored in the data storage.
The following shows selectable items.
• [Rise]

Deletes the data at the rise of the bit device.
Specify a bit device.

• [Fall]
Deletes the data at the fall of the bit device.
Specify a bit device.

• [Power-on]
Deletes the data at the GOT startup.

• [Output]
Deletes the data upon its output.

Item Description

[Output Trigger]

This item appears when [Output Timing] is set to [When trigger condition is satisfied] or 
[When one page's worth of data is collected].
Select a trigger to output the collected data.
The following shows selectable items.
• [Rise]

Outputs the data on the rising edge of a bit device.
Specify a bit device.

• [Fall]
Outputs the data on the falling edge of a bit device.
Specify a bit device.

[Abort Trigger]

This item appears when [Output Destination] is set to [Printer], and [Output Timing] is set 
to [When trigger condition is satisfied] or [At the time of data collection].
Select a trigger to abort an output.
The following shows selectable items.
• [None]

Does not use the abort trigger.
• [Rise]

Aborts an output on the rising edge of a bit device.
Specify a bit device.

• [Fall]
Aborts an output on the falling edge of a bit device.
Specify a bit device.

Item Description

[Process Notification Device]

This item appears in either of the following conditions.
• [Output Timing] is set to [When trigger condition is satisfied] or [When one page's worth 

of data is collected].
• [Repeat] is included in [Output Target].
Select this item when using the process notification function and set a device to be used 
as the process notification device.
You can specify a word device or word-specified bit device.For details on the process 
notification device, refer to the following.

➟10.11.3 ■8 Process notification device

[Temporary File Name]

This item appears when [Output Timing] is set to [When trigger condition is satisfied].
Name a temporary file.
A temporary file will be created per report screen.
Up to eight one-byte alphabetic characters (uppercase) and numbers (0 to 9) can be 
entered.
Specify a unique temporary file name.

[Limit of Collection]

This item appears when [Output Timing] is set to [When trigger condition is satisfied].
Set the maximum number of collections of data to be stored into a temporary file.
The setting range is [1] to [10000].
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be 
changed.

Item Description
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■3 [Format] tab

1) [Output page header]
Not available to GT21, GT SoftGOT2000, and GS21.
This item appears when [Specification] is set to [Direct] or [Device] in the [File Save] tab.
Outputs the page header.
For the page header, refer to the following.

➟10.11 Outputting the Collected Data as a Report (Report Function)
2) [Set header]

Set the header.
Make sure that the number of lines to be output does not exceed the set value of [Page Lines] in the [Report Setting] 
dialog.

➟10.11 Outputting the Collected Data as a Report (Report Function)
The header lines are not settable as the footer or repeat lines.

• [Start]
Specify the start line of the header.

• [End]
Specify the end line of the header.

[Behavior when it exceeds the limit]

This item appears when [Output Timing] is set to [When trigger condition is satisfied].
Select how data will be collected and stored into a temporary file if the maximum number 
of collections of data in the file is exceeded.
The following shows selectable items.
• [Abort]

Aborts the data collection.
The data collection will resume after the data in the temporary file is deleted by the delete 
trigger.

• [Overwrite]
Continues the data collection, and overwrites the temporary file.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Body Setting]

4) [Repeat]
Specify lines to be output repeatedly.
Make sure that the number of lines to be output does not exceed the set value of [Page Lines] in the [Report Setting] 
dialog.
The repeat lines are not settable as the header or footer lines.

5) [Set footer]
Set the footer.
Make sure that the number of lines to be output does not exceed the set value of [Page Lines] in the [Report Setting] 
dialog.
The footer lines are not settable as the header or repeat lines.

• [Start]
Specify the start line of the footer.

• [End]
Specify the end line of the footer.

6) [Output page No.]
This item appears when [Output Destination] is set to [Printer] in the [Action] tab.
Outputs page numbers.
Select where the page number will be output with [Position].
The setting is fixed to [Top right].

7) [Output date/time]
This item appears when [Output Destination] is set to [Printer] in the [Action] tab.
Outputs the date and time on which a report is printed.
Select where the date and time will be output with [Position].
The following shows selectable items.

• [Top left]
• [Top center]
• [Top right]

The year, month, day, hour, minute, and second will appear in that order.
Example) 18/07/01 16:53:41

Item Description

[Output Target]

Select an item to be output.
The following shows selectable items.
• [Repeat]
• [Alarm]
• [Operation Log] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
For the settings required to output an alarm line, refer to the following.

➟10.11.3 ■4 Settings to output alarm lines
For the settings required to output an operation log line, refer to the following.

➟10.11.3 ■5 Settings to output operation log lines

[Output Order]

Not available to GT21 and GS21.
This item appears when [Output Timing] is set to [When trigger condition is satisfied] in the 
[Action] tab.
Select the order in which data is output from a temporary file.
The following shows selectable items.
• [Chronological]
• [Reverse chronological]

[Number of repeats]

Not available to GT21 and GS21.
This item appears when [Output Timing] is set to [When trigger condition is satisfied] in the 
[Action] tab.
Specify the number of times that the specified lines are repeated.
The setting range is [0] to [9999].
To output the data of all temporary files in the data storage, specify the following value: the 
set value of [Limit of Collection] in the [Action] tab - 1.
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be 
changed.

Item Description

[Start] Specify the start line to be output repeatedly.

[End] Specify the end line to be output repeatedly.
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8) [Output page footer]
Not available to GT21, GT SoftGOT2000, and GS21.
This item appears when [Specification] is set to [Direct] or [Device] in the [File Save] tab.
Outputs the page footer.
For the page footer, refer to the following.

➟10.11 Outputting the Collected Data as a Report (Report Function)
9) [Insert a page break at the end of a report screen]

Not available to GT21, GT SoftGOT2000, and GS21.
This item appears when [Output Destination] is set to [File] and [Output Timing] is set to [When trigger condition is 
satisfied] in the [Action] tab.
Inserts a page break after a report screen section.
If you output the data of multiple report screens to one report file, you can insert a page break after the section of 
your preferred report screen.
Example) Inserting a page break after the section of report screen 3 when outputting the data of report screens 1 
to 3 repeatedly
The following shows how the data of report screens 1 to 3 are output.

Report screen Settings

Report screen 1
• [Specification] in the [File Save] tab: [Direct]
• [File Name] in the [File Save] tab: REPORT01
• [Insert a page break at the end of a report screen]: Not selected

Report screen 2
• [Specification] in the [File Save] tab: [Add to other report file]
• [Screen No.] in the [File Save] tab: 1
• [Insert a page break at the end of a report screen]: Not selected

Report screen 3
• [Specification] in the [File Save] tab: [Add to other report file]
• [Screen No.] in the [File Save] tab: 1
• [Insert a page break at the end of a report screen]: Selected

REPORT01_0000.G2R

Page 1 Page 2

Header Header

Footer

Section of 
report screen 1

Section of 
report screen 1

Section of 
report screen 2

Section of 
report screen 3

A footer will be inserted after the 
section of report screen 3.

Screen data will be output to a 
new page at the next output.
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■4 [File Save] tab

The [File Save] tab appears when [Output Destination] is set to [File] in the [Action] tab.

1) [Destination]

Item Description

[Specification]

Select how to specify a destination report file.
The following shows selectable items.
• [Direct]

Saves the screen data to the user-specified file.
The specified file will be created when the screen data is output to the file.

• [Device]
Saves the screen data to the file that is specified with the user-specified devices.
The specified file will be created when the screen data is output to the file.

• [Add to other report file]
Adds the screen data to the report file created for another report screen.

For information on how to specify a report file, refer to the following.

➟10.11.2 ■7 (1) Specifying a report file

[Drive Name]

This item appears when [Specification] is set to [Direct].
Select the drive to which a report file will be saved.
The following shows selectable items.
• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

[Folder Name]

This item appears when [Specification] is set to [Direct].
Specify the folder to which a report file will be saved.
For the restrictions on the folder name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

[File Name]

This item appears when [Specification] is set to [Direct].
Set the name of a report file.
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
Specify a unique report file name.
For the details of a report file, refer to the following.

➟10.11 Outputting the Collected Data as a Report (Report Function)

[Add date information to the file name]
This item appears when [Specification] is set to [Direct].
Appends the creation date (year, month, and day) to the name of the report file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)

When [Specification] is set to [Direct]

When [Specification] is set to [Device]

When [Specification] is 

set to [Add to other report file]
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2) [File Management]

[Separate destinations for each GOT]

Available to GT27, GT25, and GS25.
This item appears when [Drive Name] is set to [N:Network Drive].
Automatically creates a folder for each GOT to save report files.
Each folder is named as the IP address of each GOT.

➟5.3.15 ■4 Creating a folder for each GOT

[Device]

This item appears when [Specification] is set to [Device].
Specify the start device of consecutive devices that store the path to the report file.

➟6.1.2 How to set devices
Unicode is supported.
Data will be read from the specified devices starting from the lower-order bits.
NULL (0x00) is supported as the termination character.

[Maximum number of characters]
This item appears when [Specification] is set to [Device].
Specify the maximum number of characters in the name of a report file.
The setting range is [4] to [74].

[Screen No.]
This item appears when [Specification] is set to [Add to other report file].
Specify a screen number or screen name to add the screen data to an existing report file.
The setting range of the screen number is [1] to [99].

Item Description

[Behavior when the capacity is insufficient]

This item appears when [Specification] is set to [Direct] or [Device].
Select how screen data will be saved to a report file when the destination drive does not 
have enough free space.
The following shows selectable items.
• [Delete old files]
• [Output no files]

Item Description
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3) [Option]
This item appears when [Specification] is set to [Direct] or [Device].

[Switch files after an output]

This item appears when [Output Timing] is set to [When trigger condition is satisfied] in the 
[Action] tab.
Write-protects the destination report file once report screen data is output to the file.
The destination report file will be switched to a new one at the next output.
If you output the data of multiple report screens to one report file, you can set when the 
destination file switching will occur.
Example) Switching the destination report file after the data of report screen 3 is output 
when outputting the data of report screens 1 to 3 repeatedly
The following shows how the data of report screens 1 to 3 are output.
• Report screen

[Specification] in the [File Save] tab: [Direct]
[File Name] in the [File Save] tab: REPORT01
[Switch files after an output]: Not selected

• Report screen 2
[Specification] in the [File Save] tab: [Add to other report file]
[Screen No.] in the [File Save] tab: 1
[Switch files after an output]: Not selected

• Report screen 3
[Specification] in [Destination]: [Add to other report file]
[Screen No.] in the [File Save] tab: 1
[Switch files after an output]: Selected

Item Description

[Control Device]

Specify a device to control the output of a report file.

➟6.1 Device Settings
A word device is settable.
For the function of each bit of the device, refer to the following.

➟(1) [Control Device]

[Notification Device]

Specify a device to notify the output status of a report file.

➟6.1 Device Settings
A word device is settable.
For the function of each bit of the device, refer to the following.

➟(2) [Notification Device]

Item Description

REPORT01_0000.G2R REPORT01_0001.G2R

The destination report file will be 
switched to a new one at the 
next output.

The report file will be write-protected 
after the data of report screen 3 is output.

Section of 
report screen 1

Section of 
report screen 1

Section of 
report screen 2

Section of 
report screen 3
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(1) [Control Device]
The following shows the function of each bit of the set device.

(2) [Notification Device]
The following shows the function of each bit of the set device.

Bit number Function

b0
When this bit is turned on, b0 of the notification device turns off and the destination report 
file is write-protected.
The destination report file will be switched to a new one at the next output.

b1

When this bit is turned on while GS524.b0 is on, a page break is inserted.
If the footer is set in the previously output report screen, the footer will be output and then 
a page break will be inserted.
This function is valid for the report screens where the output destination is set to a file.
For GS524, refer to the following.

➟12.1.3 GOT special register (GS)

Bit number Function

b0

Turns on when a report file is created.
Turns off when the destination report file becomes write-protected under the following 
conditions.
• B0 of the control device is turned on.
• The data of a report screen is output when [Switch files after an output] is enabled for the 

screen.

b1

Turns on when an output is aborted due to data storage anomalies.
Turns off after the data storage recovers from the anomalies and the output is complete.
When [Output Timing] is set to [At the time of data collection], up to 200 files of alarm and 
operation log data collected during the output interruption will be held.
Any files over the 200 file limit will be discarded.
The held data will be output upon resumption of output.

b2

Turns on when the output is aborted because the report file name is unspecified, duplicate, 
or invalid.
Turns off after the report file name is specified correctly and the output is complete.
When [Output Timing] is set to [At the time of data collection], up to 200 files of alarm and 
operation log data collected during the output interruption will be held.
Any files over the 200 file limit will be discarded.
The held data will be output upon resumption of output.

b3
Turns on when any files of alarm and operation log data over the 200 file limit are discarded 
due to the causes mentioned above.
Turns off after the causes are eliminated and the output is complete.
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2.8 Managing the Created Screen

The created screen is displayed on the [Screen] window and [Screen Image List] window.
You can copy or delete the screen on each window.

• [Screen] window
Displays the screen view tree with the screen number and title of the created screens.
Whether the script and trigger action is set for each screen can be displayed.

➟2.2.4 ■3 [Screen] window
• [Screen Image List] window

The mobile screen is available to GT27, GT25, GT SoftGOT2000, and GS25.
Displays the icons of created base screens, window screens, and mobile screens.

➟2.8.1 [Screen Image List] window

2.8.1 [Screen Image List] window

Either of the following operations displays the [Screen Image List] window.
• Select [Display] → [Docking Window] → [Screen Image List] from the menu.
• Select [Screen] → [Screen Image List] from the menu.

Display speed of screen images
To speed up the display of screen images, select [Include projects for the function of Utilize Data] in the [Project 
information] dialog.

1) Screen types
Select the type of the screen to be displayed in the screen image list.
The following shows the items to be selected.

• [Base Screen]
Displays base screens.

• [Window Screen]
Displays window screens.

• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)
Displays the icons of mobile screens.

• [An image of set overlay screen(Base Screen)]
Displays the icons of base screens for the set overlay screen function.

• [An image of set overlay screen(Window Screen)]
Displays the icons of window screens for the set overlay screen function.

• [An image of set overlay screen(Mobile Screen)] (GT27, GT25, GT SoftGOT2000, and GS25)
Displays the icons of mobile screens for the set overlay screen function.

2) [Register] button
Creates a new screen utilizing the figure or object selected on the screen editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
4)

5)
6)

7)
8)

9)
10)

11)
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3) [New] button
Creates a new screen of the type selected in the screen types.

4) [Edit] button
Opens the screen selected in the screen image list.

5) [Name] button
Switches between displaying and hiding screen numbers and titles in the screen image list.

6) [Cut] button
Cuts the screen selected in the screen image list.

7) [Copy] button
Copies the screen selected in the screen image list.

8) [Paste] button
Pastes the screen cut or copied in the screen image list.
The screen appears after the paste.

9) [Delete] button
Deletes the screen selected in the screen image list.

10) [Property] button
Displays the [Screen Property] dialog of the screen selected in the screen image list.

11) Screen image list
Lists the images of the created screens.
When the display or edit of a screen is disabled by the project security, the screen image is displayed as shown 
below.

Edit-disabled screen

Display-disabled screen
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2.9 Viewing the Image of the Created Screen

➟2.9.1 Displaying a preview
2.9.2 Displaying the preview of a window screen on the screen editor

2.9.1 Displaying a preview

Step 1 Select the screen editor of the base screen or window screen to display the preview.

➟2.6.1 Selecting a screen editor to be edited
Step 2 Select [Display] → [Preview] from the menu to display the [Screen preview] window.

Edit the screen editor to apply the edit contents to the [Screen Preview] window.
➟■1 [Screen preview] window

■2 Precautions

■1 [Screen preview] window

1) Title bar
Screen number and title of the previewed screen

2) Menu bar
Operate the [Screen Preview] window from the pull-down menu.

➟(1) Menu bar
3) Toolbar

Use the buttons and other items to operate the [Screen Preview] window.
➟(2) Toolbar

4) Display section
Displays the preview of the screen editor.
The scroll bars appear on the expanded base screens.
Each time you click the superimposed part of objects while holding down the [Ctrl] key, the selected object is shifted 
in order from the topmost object.
Right-click the display section to display the menu.
The available items are the same as those in [Display] in the menu.

➟2.9.1 ■1 (1) (b) [Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Click a Go To Screen switch for which an option other than [Fixed] is selected in [Next Station] to display the [Screen 
No. Specification] dialog.
In this dialog, you can set the destination screen number.

Click the numerical display, numerical input, text display, or text input to display the [Preview Value] dialog.
In this dialog, you can change the value to be displayed.

5) Description bar
Displays the operation description of the [Screen Preview] window.

6) Status bar
The following are displayed according to the position of the mouse cursor and setting of the preview.

• Type and condition of an object which the mouse cursor is pointed to
• Condition in preview
• Number of colors being previewed

(1) Menu bar

(a) [File]

(b) [Display]

• [Screen Type]
Displays the screen type.

• [Screen No.]
Set the destination screen number.
The setting range is [0] to [32767].

• [Preview Value]
Set the value to be displayed.

Menu Description

[Save] Saves the image of the display section in the BMP format. 
Shortcut key: [Ctrl] + [Shift] + [S]

[Print] Prints the image of the display section.

[Printer Setting] Sets the printer for printing.

[Output in reverse] Switches between reversing the color and leaving the color unreversed when an 
image is output to a printer or file.

[Fill Black at Text BG] Outputs an image with the text in white and background in black to a printer or file.

[Dithering] Outputs an image with the intermediated color added to the two-tone monochrome 
to a printer or file.

[Copy Screen Image to Clip Board] Captures the image of the display section.

[Close] Closes the [Screen Preview] window.

Menu Description

[Menu and Title] Switches between displaying and hiding the menu bar and title bar.

[Toolbar] Switches between displaying and hiding the toolbar.

[Status bar] Switches between displaying and hiding the status bar.

[Description Bar] Switches between displaying and hiding the description bar.

[Next Screen] Switches to a screen whose screen number is one greater than that of the currently 
displayed screen.

[Previous Screen] Switches to a screen whose screen number is one smaller than that of the currently 
displayed screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(c) [Option]

[Use Preview No.] Switches between enabling and disabling the preview number as the column No. of 
the comment group.

[ON Image] Switches between on and off of the object to be displayed.

[Next State] Switches the states of objects to be displayed on screen editors in ascending order.

[Previous State] Switches the states of objects to be displayed on screen editors in descending order.

[Overlap Window1] Switches between displaying and hiding the overlap window 1.

[Overlap Window2] Switches between displaying and hiding the overlap window 2.

[Overlap Window3] Switches between displaying and hiding the overlap window 3.

[Overlap Window4] Switches between displaying and hiding the overlap window 4.

[Overlap Window5] Switches between displaying and hiding the overlap window 5.

[Superimpose 1] Switches between displaying and hiding the superimpose window 1.

[Superimpose 2] Switches between displaying and hiding the superimpose window 2.

[Key Window] Switches between displaying and hiding the key window.

[Dialog Window] Switches between displaying and hiding the dialog window.

[PC Remote Operation] Switches between displaying and hiding the remote screen.

[65536 Colors] Previews a screen in 65536 colors.

[32(Grayscale)] Previews a screen in 32-level grayscale.

[Show the entire base screen]

Switches between the view modes of the expanded base screens.
The following shows the view modes.
• The area of the base screen for the GOT to display
• The entire expanded base screen

[Show the Screen Only]
Deletes the menu bar and other bars to display only the image of the display section. 
Double-clicking the display section also switches the display. 
Shortcut key: [Shift] + [F4]

Menu Description

[Open the editing screen in conjunction with Screen 
Preview]

Switches between displaying and hiding the screen editor of the screen displayed on 
the [Screen Preview] window.

[Display the frame around the selected item] Switches between displaying and hiding the frame of the target which mouse cursor 
is pointed to.

Menu Description
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(2) Toolbar

1) [Screen Type]
Select the type of the screen to be displayed.

2) [Screen No.]
Select the screen number of the screen to be displayed.

3) [Previous Screen]
Switches to a screen whose screen number is one smaller than that of the currently displayed screen.

4) [Next Screen]
Switches to a screen whose screen number is one greater than that of the currently displayed screen.

5) [Open the editing screen]
Displays the screen editor of the screen displayed on the [Screen Preview] window.

6) [Save]
Saves the image of the display section in the BMP format.

7) [Print]
Prints the image of the display section.

8) [ON], [OFF]
Switches between on and off of the object to be displayed.

9) [Previous State]
Switches the states of objects to be displayed on screen editors in descending order.

10) [Next State]
Switches the states of objects to be displayed on screen editors in ascending order.

11) [State No.]
Switches the states of objects to be displayed on screen editors by selecting the state No.

12) [Language Switching]
Select the column No. for a comment group to be displayed.

13) [Security]
Select the security level.
Only the objects which can be displayed in the selected security level are displayed.

14) [Color Setting]
Only available to GT2105-Q.
Select the number of colors for previewing a screen.

■2 Precautions

(1) Object which cannot be displayed on the preview window
The parts movement is not displayed on the [Screen Preview] window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.9.2 Displaying the preview of a window screen on the screen editor

When arranging a window position object on the screen editor, you can display the preview of the window screen.
The preview of a window screen on a mobile screen is available to GT27, GT25, GT SoftGOT2000, and GS25.

Step 1 Select [Display] → [Window Preview] → [Setting] from the menu to display the [Window Preview] dialog.

➟■1 [Window Preview] dialog
Step 2 Set the window screen to be displayed in the preview of each screen. Then click the [OK] button.

When a window screen on a mobile screen is previewed, if the window screen has the setting configured for previewing 
another window screen, that window screen will not be previewed.

■1 [Window Preview] dialog

The preview of a window screen on a mobile screen is available to GT27, GT25, GT SoftGOT2000, and GS25.

1) Window preview
Set the window screens, such as an overlap window, to be displayed on the screen editor.
Set the screen number of window screens to be displayed.
The setting range is [0] to [32767].
Click the [Browse] button to display the [Screen Image List] dialog.
You can check the image on the screen when selecting a window screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.
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Base screen Mobile screen

Screen image list
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2) [PC Remote Operation(Ethernet)]
Displays the preview of the remote screen of the remote personal computer operation function (Ethernet).
Not available for mobile screens.
Not available to GT23, GT21, GT SoftGOT2000, and GS21.
Displays the preview of the overlap window used as a system window, instead of the preview of the personal 
computer screen.
Example) Using overlap window 4 as a system window
Place a window position object for overlap window 4 to display the preview of the personal computer screen.

3) [Apply to All Base Screens]
Applies the settings in the [Window Preview] dialog to all the base screens.

4) [Apply to all mobile screens]
Applies the settings in the [Window Preview] dialog to all the mobile screens.

Item Description

[Overlap Window1] Displays the preview of overlap window 1.

[Overlap Window2] Displays the preview of overlap window 2.

[Overlap Window3]
Displays the preview of overlap window 3.
Not available for mobile screens.
Not available to GT23, GT21, and GS21.

[Overlap Window4]
Displays the preview of overlap window 4.
Not available for mobile screens.
Not available to GT23, GT21, and GS21.

[Overlap Window5]
Displays the preview of overlap window 5.
Not available for mobile screens.
Not available to GT23, GT21, and GS21.

[Superimpose Window1] Displays the preview of superimpose window 1.

[Superimpose Window2] Displays the preview of superimpose window 2.

[Key Window]

Displays the preview of the key window. 
Select a standard key window to be displayed. 
The following shows the items to be selected.
• [Dec Key Window]
• [Hex Key Window]
• [Text Key Window]
Not available for mobile screens.

[Dialog Window]
Displays the preview of the dialog window.
Not available for mobile screens.

Item Description

[Preview Size] Set the size of the window.
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2.10 Copying and Deleting Screens

➟2.10.1 Copying screens
2.10.2 Deleting screens

2.10.1 Copying screens

Screens can be copied from the [Screen] window, [Screen Image List] window, and menu.
For the operation of the [Screen] window and [Screen Image List] window, refer to the following.

➟2.2.4 ■3 [Screen] window
2.8.1 [Screen Image List] window

For how to copy a base screen or window screen to create a mobile screen, refer to the following.
➟10.19.3 ■5 Copying a base screen or window screen to a mobile screen

The following shows how to copy screens from the menu.
Step 1 Select [Screen] → [Copy] from the menu to display the [Copy Screen] dialog.

➟■2 [Copy Screen] dialog
Step 2 Select the screen to be copied in the screen list and set [Destination No.] and [Number of Copy].
Step 3 Click the [Copy] button to create a screen.

■1 Specifications on how screen data is copied
(1) Setting of the screen trigger action and screen script

When the trigger action or script is set to the screen to be copied, the setting of the trigger action or script is also copied.

(2) Project for which project security is set
For operating the project for which project security is set, refer to the following.

➟2.13 Protecting a Project by Registering Users

(3) Settings that are not migrated when report screens are copied
Some settings of report screens are not migrated, but their default values are set.
The following settings in the [Screen Property] dialog are not migrated.

• [Temporary File Name] in the [Action] tab
• [File Name] in the [File Save] tab

■2 [Copy Screen] dialog

1) List of screens
List of the created screens
Select a screen to be copied.
Use the [Ctrl] key or [Shift] key to select up to 25 screens of the same type.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2) [Destination No.]
Set the screen number of the screen to be created.
The setting range depends on the screen type.

• Base screen, window screen, or mobile screen: [0] to [32767]
• Report screen: [1] to [99]

3) [Number of Copy]
Set the number of copies.
The setting range depends on the screen type.

• Base screen, window screen, or mobile screen: [1] to [100]
• Report screen: [1] to [99]

The screen numbers after the second copied screen are set sequentially from the number set in [Destination No.].
If you copy the screens exceeding the number of the maximum number of the screen setting or range of the screen 
number, the screens cannot be copied.

2.10.2 Deleting screens

Screens can be deleted from the [Screen] window, [Screen Image List] window, and the menu.
For the operation of the [Screen] window and [Screen Image List] window, refer to the following.

➟2.2.4 ■3 [Screen] window
2.8.1 [Screen Image List] window

The following shows how to delete screens from the menu.
Step 1 Select [Screen] → [Delete] from the menu to display the [Delete Screen] dialog.

➟■1 [Delete Screen] dialog
Step 2 Select the screen to be deleted in the screen list and click the [Delete] button to delete the screen.

Project for which project security is set
The screen for which editing is prohibited cannot be deleted.

■1 [Delete Screen] dialog

1) List of screens
List of the created screens
Select a screen to be deleted.
Use [Ctrl] key or [Shift] key to select multiple screens of the same type.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.11 Performing a Data Check

■1 Checking that no error exists in the project
Select [Tool] → [Data Check] → [Check] from the menu to display the check result in the [Data Check List] window.

➟2.11.1 [Data Check List] window
To narrow the check items, change the setting in the [Check Item Setting] dialog.
To display the [Check Item Setting] dialog, perform one of the following operations.

• Select [Tool] → [Data Check] → [Item Setting] from the menu.
• Click the [Option] button in [Data Check List] to select [Check Item Setting] from the pull-down menu.

➟2.11.2 [Check Item Setting] dialog

■2 Exporting the check result
You can export the check result in a CSV format or Unicode text format.

Step 1 Click the [Option] button in the [Data Check List] window and select [Export] from the pull-down menu to 
display the [Save As] dialog.

Step 2 Set [File name] and [Files of type] and click the [OK] button to export the check result.

➟2.11.3 Details of the exported file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.11.1 [Data Check List] window

1) [Check] button
Checks the items selected in the [Check Item Setting] dialog.

2) [Option] button
Operates the [Data Check List] window from the pull-down menu.

3) [Refinement]
Narrow the displayed contents of the check result by keywords.
Up to 128 characters can be set.
To narrow the contents using multiple keywords, separate each keyword with one-byte spaces.

4) [Range]
Range selected in [Object No.] of the [Check Item] dialog

5) Number of errors
Number of settings which do not perform operation

6) Number of warnings
Number of settings which cause unintentional operation

7) List of check results
Displays the check result.
Double-click a result to jump to the position which causes an error or warning.

Item Description

[Check Item Setting]
Displays the [Check Item Setting] dialog. 
In this dialog, you can set the check target and check item.
➟2.11.2 [Check Item Setting] dialog

[Export]
Exports the check result as a CSV file or Unicode text file. 
Set [File name] and [Files of type] in the displayed dialog and click the [Save] button.
➟2.11.3 Details of the exported file

Item Description

[Massage No.] Message No. of an error or warning

[Type]
Type of a detected event
• [Error]: Setting which does not perform operation
• [Warning]: Setting which causes unintentional operation

[Screen]

Screen with the cause of an error or warning
• [B-n]: Base screen ("n" indicates the screen number.)
• [W-n]: Window screen ("n" indicates the screen number.)
• [R-n]: Report screen ("n" indicates the screen number.)
• [M-n]: Mobile screen ("n" indicates the screen number.)

[Contents] Message which shows the description of an error or warning

[Object ID] Object ID of the cause of an error or warning

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.11.2 [Check Item Setting] dialog

1) [Object No.]
Select the check target.
The following shows the items to be selected.

• [All screens]
Select this item to check all the screens in the project and common settings.

• [Open Screen]
Select this item to check all the opened screens and common settings.

• [Editing screen]
Select this item to check the screen whose screen editor is displayed at the topmost position and common 
settings.

2) [Error Check Item]
Items for checking whether any setting which does not perform operation exists
Select the items to check.

Item Description

[Key Count] Checks whether 1024 or more touch switches are arranged in one screen.

[Memory Store Object] Checks whether 16 or more scatter graphs (when [Store Memory] is set) are arranged in 
one screen.

[Historical Trend Graph Device] Checks whether a mismatch exists in the logging setting and device setting in the historical 
trend graph.

[Historical Data List Display Device]
Checks whether a mismatch exists in the following settings.
• Logging setting and device setting in the historical data list display
• Device format in the historical data list display and device display

[Report Data]

Checks the following settings of the [Screen Property] dialog (report screen).
Settings in the [Action] tab
• Checks whether the setting of [Temporary File Name] in [Detail Setting] is duplicated with 

other report screens.
Settings in the [Format] tab
• Checks whether the total number of header, footer, and repeat lines exceeds the set 

value of [Page Lines] in the [Report Setting] dialog.
Settings in the [File Save] tab
• Checks whether the save destination setting is duplicated with other report screens.
• Checks whether the specified report screen exists and [Output Destination] is set to 

[Printer] when [Specification] is set to [Add to other report file].
Checks the following settings in the [Report Setting] dialog.
• Checks whether the total number of characters specified for [Text] and [Device] in the 

[Edit Page Header/Page Footer] dialog exceeds the set value of [Page Columns] in the 
[Report Setting] dialog.
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3) [Alarm Check Item]
Items for checking that any setting which causes unintentional operation does not exist.
Select the items to check.

[Dialog Window]

Checks the following for the setting in the [Screen Property] dialog of the base screen and 
window screen or [Dialog Window] in the [Environmental Setting] window.
• Checks whether the screen number of a window screen which does not exist is set to a 

dialog window.
• Checks whether the screen size of the window screen is 320 × 240 or more.

[Comment File Name]

Not available to GT23, GT21, and GS21.
Checks the comment group settings for duplicate comment text file paths.
For comment text files, refer to the following.

➟5.8.2 ■5 Importing or exporting comments

[Alarm Device] Checks that the alarm device and alarm range are set correctly in the user alarm 
observation.

[Recipe (Device/Alarm name)]

Checks the following for the setting in the [Recipe Common Setting] dialog and [Recipe] 
dialog.
• Checks that the common control device and external notification device are not 

duplicated with the screen switching device or station No. switching device.
• Checks that the recipe files (file path) in each recipe setting are not duplicated.

[Logging File Name] Checks that the settings(file path) of the destination to save files in each logging setting are 
not duplicated.

[CH No. Settings]

Checks that any channel which is not used is not set to the following settings.
• [CH No. for Station No. Switching] in [Station No. Switching] in the [Controller Setting] 

window
• [Adjust CH No.] in the [Adjust] tab in [Time Setting] in the [GOT Setup] window
• [Broadcast CH No.] in the [Broadcast] tab in [Time Setting] in the [GOT Setup] window
• [Controller CH No.] in [Transparent Mode Setting] in the [GOT Setup] window

[Number of the retains data in the SRAM user 
area under power failure]

Not available to GT21 and GS21.
Checks the following.
• The SRAM power-failure backup function is enabled for a maximum of 10 alarm 

observation settings.
• The SRAM power-failure backup function is enabled for a maximum of 20 logging 

settings.

[GOT Mobile Setting]

Not available to GT23, GT21 and GS21.
Checks the following.
• Checks that GOT Mobile devices (VGB and VGD) are only specified in the mobile 

screens and in the [GOT Mobile Setting] window.
• Checks that specified GOT Mobile devices (VGB and VGD) are within the setting ranges.
• Checks that [Use GOT Mobile function] is selected when a mobile screen is used.

[OPC UA Setting]
Only available to GT SoftGOT2000.
Checks that no invalid OPC UA tag is set in device settings.

Item Description

[Key Overlap]

Checks whether the following objects are overlapped.
• Touch switch
• Numerical input
• Text input
• Historical data list (when [Single Touch Operation] is set)
• Trend graph (when [Single Touch Operation] is set)
• Historical trend graph (when [Single Touch Operation] is set)
• Alarm display
• Simple alarm display (when [Operation] is selected in [Touch Mode])
• Slider
• Recipe Display (Record List)
Objects in the temporary area are not checked.
The overlap of an object on a screen opened using the set overlay screen and an object 
on the basic screen is not checked.

[Valid Screen Area] Checks that objects are not arranged out of the screen display area.

[Invalid Device] Checks that any device for which [??] is set does not exist.

[Data Size] Checks the total size of the project size and SRAM user area to be used.

[GOT Mobile Setting (device range)]
Not available to GT23, GT21 and GS21.
Checks that the GOT internal devices (GB and GD) assigned to GOT Mobile devices (VGB 
and VGD) are not specified for other settings.

[Script Syntax (Script Parts)] Checks the script parts for possible errors in their scripts.

Item Description
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4) [Select All] button
Checks all the items in the check item.

5) [Deselect All] button
Unchecks all the items in the check item.

6) [Data Checking at Save or Communication]
Performs a data check when a project is saved and package data is transferred.

7) [Continue Save Processing even with Error]
Saves a project even if an error is found when the project is saved.

8) [Maximum number of display items]
Set the maximum number of errors and warnings displayed in the [Data Check List] window.
The setting range is [1] to [1000].

2.11.3 Details of the exported file

The following shows the details of the exported file of a check result.

1) [Target Screen]
Target screens which are selected in [Target screen] of the [Check Item Setting] dialog

2) [Massage No.]
Message No. of a detected error or warning

3) [Type]
Type of a detected event

• [Error]: Setting which does not perform operation
• [Warning]: Setting which causes unintentional operation

4) [Screen]
Screen with the cause of a detected error or warning

• [B-n]: Base screen ("n" indicates the screen number.)
• [W-n]: Window screen ("n" indicates the screen number.)
• [R-n]: Report screen ("n" indicates the screen number.)
• [M-n]: Mobile screen ("n" indicates the screen number.)

5) [Contents]
Message which shows the description of a detected error or warning

6) [Object ID]
Object ID of the cause of a detected error or warning
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2.12 Protecting a Project with a Security Key

➟2.12.1 Specifications of the security key authentication
2.12.2 How to use the security key authentication
2.12.3 Precautions
2.12.4 [Security Key Setting] dialog
2.12.5 [Security Key Management] dialog

The security key authentication restricts project operations by using a security key.
When assigning a security key to GT Designer3, a project, and the GOT, you can operate the project only by using the 
matched security key.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Project

Key A

Key A Key A

Authentication Authentication
GT Designer3 GOT

Security key assignment target Operation

GT Designer3 Viewing a project to which the security key is assigned is available.

Project
The following operations are restricted.
• Viewing the project on GT Designer3
• Executing the project on the GOT

GOT Executing a project to which the security key is assigned is available.
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■1 Operations restricted with a security key
(1) Viewing a project on GT Designer3

A project protected with a security key can only be viewed on GT Designer3 that has the matched security key.

(2) Executing a project on the GOT
A project protected with a security key can only be executed on the GOT that has the matched security key.

■2 Copying a security key
A security key can be assigned to multiple personal computers by exporting and importing the key.
Operation authority restrictions and the expiration date are settable for the security key to be exported.

ProjectKey AKey A
Matched

Not matched
Key B ProjectKey A

Viewing the project is available.

Viewing the project is not available.

ProjectKey AKey A
Matched

Not matched
Key B ProjectKey A

Executing the project is available.

Executing the project is not available.

Project

Key A

Export Key A Import

View

Writing a security key to the GOT

View

Writing a security key to the GOT
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2.12.1 Specifications of the security key authentication

➟■1 Operations restricted by the security key authentication
■2 Security key specifications
■3 Project-related specifications
■4 GOT-related specifications

■1 Operations restricted by the security key authentication

The security key authentication restricts the following operations.
• Viewing a project on GT Designer3
• Executing a project on the GOT

To restrict operations other than the above, use the following security functions.
Using multiple security functions in combination further strengthens the security.

(1) Function restricting project operations

(2) Function restricting communication with the GOT

(3) Function restricting the GOT operations

■2 Security key specifications

(1) Number of registrable security keys
Security keys registered on GT Designer3 are shared among all of the MELSOFT applications, such as GX Works3.
Up to 128 security keys are registrable by user account on the personal computer.

(2) Name of a security key
You cannot create a security key with the same name as an existing security key.
Even if you delete the existing security key and then create a new one with the same name, the new one is recognized 
as a different security key.

(3) Deletion of a security key
Even if GT Designer3 is uninstalled, security keys still remain in the personal computer.
To delete security keys, use GT Designer3.

➟2.12.2 ■1 (1) Creating a security key

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Function Description

Project security
Restricts unregistered users to view or edit a project by registering users with the project. 
Also restricts operations by screen according to the access level of each user.
➟2.13 Protecting a Project by Registering Users

Function Description

Data transfer security
Restricts data transfer between the personal computer (GT Designer3) and the GOT with a password.
➟5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

IP filter
Restricts access to the GOT by Ethernet by registering IP addresses with the filtering list.
➟5.4.3 Setting the IP filter

Function Description

Screen security
Restricts the display of screens and objects on the GOT by registering users with the GOT.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Functional operation security
Restricts the display of the utility, and operations of some monitor functions.
➟5.2.9 Configuring the security settings for operations in the utility ([Functional Operation Security])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Authority of a security key
The operation authority and the expiration date are settable for a security key to be exported.

■3 Project-related specifications

(1) Project to which a security key can be assigned
The following shows the formats of projects to which a security key can be assigned.

• Workspace format for the GOT2000 series
• Single file format (*.GTX, *.GTXS)

(2) Number of security keys that can be assigned to a project
One security key can be assigned to one project.
Assigning a security key to the project again overwrites the already assigned security key.

(3) Project viewing availability according to security key assignment
The following shows the project viewing availability according to the security key assignment.

(4) Transferring data containing a protected project
Package data containing a protected project is written to drive C of the GOT only.
The package data cannot be directly opened from the data storage.

■4 GOT-related specifications

(1) Version of the BootOS
To enable the security key authentication on the GOT, install version J or later of BootOS.

➟4.5.3 Installing the BootOS or the CoreOS to the GOT

(2) Number of security keys writable to the GOT
One security key can be written to one GOT.

(3) Project execution availability according to security key assignment
The following shows the project execution availability according to the security key assignment.

Security key Operation authority Expiration date

New security key Not restricted Not set

Security key to be exported

Whether to allow the following operations after 
the security key is imported is settable.
• Exporting the security key
• Assigning the security key to a project
• Writing the security key to the GOT

The expiration date for using the security key is 
settable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Designer3 Project View of project

Security key assigned

Security key assigned (The security key matches the 
one on GT Designer3.) Available

Security key assigned (The security key does not match 
the one on GT Designer3.) Not available

No security key assigned Available

No security key assigned
Security key assigned Not available

No security key assigned Available
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GOT Project Execution of project

Security key assigned

Security key assigned (The security key matches the 
one on the GOT.) Available

Security key assigned (The security key does not match 
the one on the GOT.) Not available

No security key assigned Available

No security key assigned
Security key assigned Not available

No security key assigned Available
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(4) Communication method for writing/deleting a security key to/from the GOT
To write/delete a security key to/from the GOT, connect the personal computer to the GOT.
The security key cannot be written to the GOT via a data storage.

2.12.2 How to use the security key authentication

The following shows how to set the security key authentication to protect a project.
Step 1 To use the security key authentication, prepare a security key at first.

Create or import a security key.
➟2.12.2 ■1 (1) Creating a security key

　 2.12.2 ■4 (2) Importing a security key
Step 2 Assign the security key to a project to be protected.

➟2.12.2 ■2 (1) Assigning a security key to a project
Step 3 Write the security key to the GOT that executes the protected project.

➟2.12.2 ■3 (1) Writing a security key to the GOT

For how to delete, export, or import a security key, refer to the following.
➟■1 Creating or deleting a security key

■2 Assigning/deleting a security key to/from a project
■3 Writing/deleting a security key to/from the GOT
■4 Copying a security key

■1 Creating or deleting a security key
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Project

Key A

2. Assign
1. Create

3. Write

Key A Key A

GT Designer3 GOT
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Key B Key CKey A

Create Delete
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(1) Creating a security key
Step 1 Select [Project] → [Security] → [Security Key Management] from the menu to display the [Security Key 

Management] dialog.

➟2.12.5 [Security Key Management] dialog

Step 2 Click the [New] button to display the [New Security Key] dialog.

➟2.12.5 ■1 [New Security Key] dialog

Step 3 Set [Name], and click the [OK] button to create a security key.

(2) Deleting a security key from GT Designer3
You cannot delete a security key, which is assigned to the project being edited.
When deleting a security key, you cannot view a project protected with the security key.
The deleted security key cannot be restored.
Even if you create a security key with the same name, the new one is recognized as a different security key.
If you need to restore the security key in case of a deletion, export the security key in advance.

Step 1 Select [Project] → [Security] → [Security Key Management] from the menu to display the [Security Key 
Management] dialog.

➟2.12.5 [Security Key Management] dialog

Step 2 Select a security key, and click the [Delete] button to delete the security key.
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■2 Assigning/deleting a security key to/from a project

(1) Assigning a security key to a project
Step 1 Prepare a security key on GT Designer3.

➟2.12.2 ■1 Creating or deleting a security key
　 2.12.2 ■4 (2) Importing a security key

Step 2 Open a project to which the security key is assigned.

➟2.3.2 ■1 Opening a project for GOT2000
Step 3 Select [Project] → [Security] → [Security Key Setting] from the menu to display the [Security Key Setting] 

dialog.

➟2.12.4 [Security Key Setting] dialog

Step 4 Select a security key in [Name], and click the [Register] button on the [Project] tab.
Step 5 The project is protected, and the assigned security key name appears in [Security Key Set in Project].
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Key B Key CKey A

Security key

Project1

Key A

Project2

Key C

Delete

Assign
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(2) Deleting a security key from a project
Step 1 Open a project from which a security key is deleted.

To open the project to which a security key is assigned, GT Designer3 must have the matched security key.
➟2.3.2 ■1 Opening a project for GOT2000

Step 2 Select [Project] → [Security] → [Security Key Setting] from the menu to display the [Security Key Setting] 
dialog.

➟2.12.4 [Security Key Setting] dialog

Step 3 Click the [Delete] button on the [Project] tab.
Step 4 The project is unprotected, and the field of [Security Key Set in Project] is blank.

■3 Writing/deleting a security key to/from the GOT

(1) Writing a security key to the GOT
Step 1 Connect the personal computer with the GOT.

➟4.3 Transferring the Data between the Personal Computer and the GOT
4.4 Transferring the Data between the Personal Computer and the GOT via PLC CPU

Step 2 Prepare a security key on GT Designer3.

➟2.12.2 ■1 Creating or deleting a security key
　 2.12.2 ■4 (2) Importing a security key
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Key A Key CKey BKey A

Security key

Write

Delete
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Step 3 Select [Project] → [Security] → [Security Key Setting] from the menu to display the [Security Key Setting] 
dialog.

➟2.12.4 [Security Key Setting] dialog

Step 4 Click the [Communication Configuration] button to display the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog

Step 5 Set the data transfer path, and click the [OK] button.
Step 6 On the [GOT] tab of the [Security Key Setting] dialog, click the [Get GOT Information] button to display the 

GOT information.
Step 7 Select a security key in [Name], and click the [Write] button.
Step 8 The security key is written to the GOT, and its name appears in [Security Key Written in GOT].

(2) Deleting a security key from the GOT
To delete a security key from the GOT, use GT Designer3 which does not need a security key matching the one on the 
GOT.
When the GOT has a project protected with a security key, deleting the security key from the GOT deletes data except 
the following ones from drive C of the GOT.

• BootOS
• Individual identification information (that is required for data transfer by Ethernet, such as the GOT IP address)

Read necessary data from the GOT in advance.
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Step 1 Connect the personal computer to the GOT.

➟4.3 Transferring the Data between the Personal Computer and the GOT
4.4 Transferring the Data between the Personal Computer and the GOT via PLC CPU

Step 2 Select [Project] → [Security] → [Security Key Setting] from the menu to display the [Security Key Setting] 
dialog.

➟2.12.4 [Security Key Setting] dialog

Step 3 Click the [Communication Configuration] button to display the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog

Step 4 Set the data transfer path, and click the [OK] button.
Step 5 On the [GOT] tab of the [Security Key Setting] dialog, click the [Get GOT Information] button to display the 

GOT information.
Step 6 Click the [Delete] button.
Step 7 The security key is deleted from the GOT, and the field of [Security Key Written in GOT] goes blank.
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■4 Copying a security key

(1) Exporting a security key
Step 1 Select [Project] → [Security] → [Security Key Management] from the menu to display the [Security Key 

Management] dialog.

➟2.12.5 [Security Key Management] dialog

Step 2 Select a security key, and click the [Export] button to display the [Export] dialog.

➟2.12.5 ■3 [Export] dialog

Step 3 Set [Detail Setting], [Password], and [Re-enter Password]. Then, click the [Export] button to display the 
[Save As] dialog.
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Key AExport Import

Import

Import

Key A
Key A

Key A

Key A
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Step 4 Set [File name], and click the [Save] button to export the security key (*.ity).
When secure mode is enabled, the extension of the security key is (*.ity2).

➟2.12.5 ■4 [Switch Secure Mode] dialog

(2) Importing a security key
Step 1 Select [Project] → [Security] → [Security Key Management] from the menu to display the [Security Key 

Management] dialog.

➟2.12.5 [Security Key Management] dialog

Step 2 Click the [Import] button to display the [Open] dialog.

Step 3 Select a file, and click the [Open] button to display the [Password Authentication] dialog.

➟2.12.5 ■2 [Password Authentication] dialog
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Step 4 Enter the password, and click the [OK] button to import the security key.
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2.12.3 Precautions

■1 Loss of a security key
If losing a security key due to a deletion operation, personal computer failures, or others, you cannot view the protected 
project.
The lost security key cannot be restored by creating a new one with the same name.
Take enough measures, such as exporting security keys and backing up them on another personal computer.

■2 Management of a personal computer that has security keys
If a personal computer having security keys is stolen, it is difficult to prevent the unauthorized view and falsification of 
projects.
To prevent the unauthorized use of the personal computer including data, take theft-prevention measures and other 
measures enough, such as deleting unnecessary user accounts.

■3 Writing/deleting a security key to/from the GOT
(1) Data in the GOT when a security key is deleted

When the GOT has a project protected with a security key, deleting the security key from the GOT deletes data except 
the following ones from drive C of the GOT.

• BootOS
• Individual identification information (that is required for data transfer by Ethernet, such as the GOT IP address)

Read necessary data from the GOT in advance.

(2) Operation in the utility
When the GOT has a project protected with a security key in drive C, the following operations are disabled in the utility.

• [Package management]: Uploading data from drive C to the other drives
• [GOT data pkg. acquisition]: Copying data while the project in drive C is executed

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.12.4 [Security Key Setting] dialog

1) [Security Key Management] button
Displays the [Security Key Management] dialog.

➟2.12.5 [Security Key Management] dialog
2) [Communication Configuration] button

Displays the [Communication Configuration] dialog.
➟4.8.8 [Communication Configuration] dialog

3) [Name]
Select a security key to be assigned to a project or the GOT.
To create a security key, select [New].

➟2.12.5 ■1 [New Security Key] dialog

Configure the security key setting for a project or the GOT by switching the tabs according to the assignment target.
➟■1 [Project] tab
■2 [GOT] tab
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3)

2)1)
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■1 [Project] tab

1) [Project Name]
Name of the project being edited

2) [Security Key Set in Project]
Name and creation date of the security key assigned to the project

3) [Register] button
Assigns a security key to the project.

4) [Delete] button
Deletes the security key assigned to the project.
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2)

4)

1)

3)
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■2 [GOT] tab

1) [GOT Type]
GOT type information acquired from the GOT
When the GOT type information cannot be acquired, writing/deleting a security key to/from the GOT is disabled.

2) [GOT Name]
GOT name information acquired from the GOT

3) [Communication Path]
Communication path between the personal computer and the GOT

4) [Get GOT information] button
Acquires information from the GOT, and enables writing/deleting a security key to/from the GOT.

5) [Security Key Written in GOT]
Name and creation date of the security key written to the GOT

6) [Write] button
Writes a security key to the GOT.

7) [Delete] button
Deletes the security key from the GOT.
When the GOT has a project protected with a security key, deleting the security key from the GOT deletes data 
except the following ones from drive C of the GOT.

• BootOS
• Individual identification information (that is required for data transfer by Ethernet, such as the GOT IP address)

Read necessary data from the GOT in advance.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

7)

1)
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2)
4)

6)
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2.12.5 [Security Key Management] dialog

1) [Registered Security Key List]
Lists security keys that can be used on GT Designer3, including the ones created with GX Works3.

2) [Import] button
Displays the [Open] dialog.
Import a security key.

3) [Export] button
Displays the [Export] dialog.
Export the security key selected in [Registered Security Key].

➟■3 [Export] dialog
4) [New] button

Displays the [New Security Key] dialog.
Create a security key.

➟■1 [New Security Key] dialog
5) [Delete] button

Deletes the security key selected in [Registered Security Key].
You cannot delete a security key, which is assigned to the project being edited.
When deleting a security key, you cannot view a project protected with the security key.
The deleted security key cannot be restored.
Even if you create a security key with the same name, the new one is recognized as a different security key.
If you need to restore the security key in case of a deletion, export the security key in advance.

6) [Switch Secure Mode] button
Displays the [Switch Secure Mode] dialog.
Enables or disables secure mode.

➟■4 [Switch Secure Mode] dialog

Item Description

[Name] Name of the security key

[Creation Date] Creation date and time of the security key

[Expiration Date] Expiration date of the security key 
Upon expiry of the date, [Expired] is displayed.

[Export] Displays the status whether exporting the security key is enabled.

[Key Registration to Project] Displays the status whether assigning the security key to a project is enabled.

[Key Registration to GOT] Displays the status whether writing the security key to the GOT is enabled.
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■1 [New Security Key] dialog

1) [Name]
Specify the name for the security key.
Up to 128 characters can be set.
Spaces at the beginning or end of the name are deleted.
You cannot specify a name already used for another security key.

■2 [Password Authentication] dialog

1) [Password]
Enter the password for the security key to be imported.

2) Password display switching button
Hides or displays the characters entered in [Password].

■3 [Export] dialog

1) [Name]
Name of the security key to be exported

2) [Creation Date]
Creation date of the security key to be exported

3) [Detail Setting]
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1) 2)
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Set restrictions on the security key to be exported.

4) [Password]
Set the password for importing the security key.
The password must be between 6 to 32 characters.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
Capital letters and small letters are distinguished.
It is recommended to make a complicated password by combining alphanumeric characters (capital letters and 
small letters) and symbols.

5) Password display switching button
Hides or displays the characters entered in [Password].

6) [Re-enter Password]
Input the same password as the one input in [Password].
When the password is not hidden, no re-entry is required.

7) [Password Strength]
Displays the strength of the password.
To export a security key, a medium or strong strength password is required.

8) [Export] button
Displays the [Save As] dialog.
Set the file name and the storage destination, and then click the [Save] button to store the security key.

Item Description

[Restriction]

Select whether to restrict the authority of the security key to be exported. 
The following shows the items to be selected.
• [Restricted]
• [Not Restricted]

[Expiration Date]

Set the expiration date of the security key in year/month/day format. 
Enter a date directly, or select a date from the popup calendar as shown below.

You cannot set a past date. 
When exporting an imported security key that has the expiration date, you cannot set a 
new expiration date later than the already set one.

[Export]

Select the authority to export the security key. 
The following shows the items to be selected.
• [Enable]
• [Disable]

[Key Registration to Project]

Select the authority to assign the security key to a project. 
The following shows the items to be selected.
• [Enable]
• [Disable]

[Key Registration to GOT]

Select the authority to write the security key to the GOT. 
The following shows the items to be selected.
• [Enable]
• [Disable]

Click

Strong
Medium
Weak
2 - 170 2. CREATING A PROJECT
2.12 Protecting a Project with a Security Key



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

■4 [Switch Secure Mode] dialog

When secure mode is enabled, the password information of the security key can be exported in an unanalyzable file 
format.

1) [Secure Mode of Security Key]
Set whether to enable or disable secure mode.
When a security key is registered in GT Designer3, secure mode switching is not available.
The following shows the items to be selected.

• [Enable]
• [Disable]
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2.13 Protecting a Project by Registering Users

Setting the project security restricts displaying and editing a project.
For specifications and settings of the project security, refer to the following.

➟2.13.1 Specifications of the project security
2.13.2 How to use the project security

■1 Preventing a project from being browsed by unauthorized people
For the project which users are registered to, the user authentication is required for opening the project.
Only registered users can open the project.

■2 Restricting for displaying and editing a project according to the access level of users
You can set restriction for displaying and editing the settings of the project according to the user's access level.
You can set restriction for displaying and editing specific screens and scripts individually besides the whole project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Registered user

Non-registered user

User 
authentication

User name

Password
+

User name: User 1
Access level: Administrators

Display: Users at the level Users 
or higher are allowed.

Edit: Users at the level Developers (Level 2) 
or higher are allowed.

Base screen 1

Display: Users at the level Developers (Level 3) 
or higher are allowed.

Edit: Users only at the level Administrators are allowed.

Script

Display: Users only at the level Administrators 
are allowed.

Edit: Users only at the level Administrators are allowed.

Whole project

User name: User 2
Access level: Developers (Level 3)

Whole project
Base screen 1
Script

: Display-enabled, edit-enabled
: Display-enabled, edit-enabled
: Display-enabled, edit-enabled

Whole project
Base screen 1
Script

: Display-enabled, edit-enabled
: Display-enabled, edit-disabled
: Display-disabled, edit-disabled

User name: User 3
Access level: Developers (Level 2)

User name: User 4
Access level: Users

Whole project
Base screen 1
Script

: Display-enabled, edit-enabled
: Display-disabled, edit-disabled
: Display-disabled, edit-disabled

Whole project
Base screen 1
Script

: Display-enabled, edit-disabled
: Display-disabled, edit-disabled
: Display-disabled, edit-disabled
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2.13.1 Specifications of the project security

➟■1 Operation restricted by the project security
■2 Concept of the project security
■3 Operating the project to which the project security is set
■4 Restricting the project operation by the access authority

■1 Operation restricted by the project security
The project security restricts the following operations.

• Viewing and editing a project on GT Designer3
• Viewing and editing a project by screen according to the user access level

To restrict operations other than the above, use the following security functions.
Using multiple security functions in combination further strengthens the security.

(1) Function restricting project operations

(2) Function restricting communication with the GOT

(3) Function restricting the GOT operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Description

Security key authentication
Restricts a project to be viewed on GT Designer3 or executed on the GOT by protecting the project with a 
security key.
➟2.12 Protecting a Project with a Security Key

Function Description

Data transfer security
Restricts data transfer between the personal computer (GT Designer3) and the GOT with a password.
➟5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

IP filter
Restricts access to the GOT by Ethernet by registering IP addresses with the filtering list.
➟5.4.3 5.4.3 Setting the IP filter

Function Description

Screen security
Restricts the display of screens and objects on the GOT by registering users with the GOT.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Functional operation security
Restricts the display of the utility, and operations of some monitor functions.
➟5.2.9 Configuring the security settings for operations in the utility ([Functional Operation Security])
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■2 Concept of the project security

When registering users to the project, set their user names and passwords for authentication and their access level.
The access privilege set for the project, screens, or others and the user's access level determine whether the user can 
display and edit the project or not.

(1) Number of registrable users
Up to 128 users can be registered.

(2) Access level
The following five access levels are provided.

(3) Access privilege type
The following two access privileges are provided.

• Display
Allows the user to display the project or screen settings.
The users whose access levels do not allow them to display the project or settings cannot display the setting dialog 
or screen images.

• Edit
Allows the user to edit, delete, and save the project or screen settings.
The users whose access levels do not allow them to edit the project or settings can display the setting dialog or 
screen images, but cannot change the settings.
If displaying is disabled, editing is always disabled.
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User

User name

Password
+

Access level
+

Protection 
target

Set the levels allowed to display and 

edit each target in the project.

Example) Whole project

Access is granted if the user access level is higher than 

that allowed to display or edit the target for the protection.

Setting access privileges

· Administrators

· Developers (Level 2)

· Developers (Level 3)

· Developers (Level 1)

· Users

High

Low
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(4) Setting access privileges
You can set a bottom access level for displaying and editing each target in the project.
If displaying is disabled, editing is always disabled.

(5) Protection target
The following shows the targets which you can set the access privileges for.

• Whole project
• Base screen, window screen, report screen, and mobile screen
• Script

Always set an access privilege for the whole project.
You can also set the access privilege for each base screen, window screen, report screen and mobile screen, or those 
screens by screen type, and the whole of scripts. This allows specific users to display or edit the relevant screens or 
scripts.

(a) Whole project
You can collectively protect all settings in a project (such as the screen setting and common setting).

(b) Base screen, window screen, report screen, and mobile screen
Setting restriction stronger than the access privilege set for the whole project to the screens allows specific users to 
display or edit the screens.
Access privileges can be set per screen.

(c) Script
Setting restriction stronger than the access privilege set for the whole project to the scripts allows specific users to display 
or edit the scripts.
The same access privilege is set for the project scripts, the screen scripts, the script symbols and the script list.
The scripts of script parts objects, object scripts, and object script symbols are not protected.
If access privileges are set for the scripts individually, the script data is always stored in the project (internal data).

■3 Operating the project to which the project security is set

(1) Logging in to a project
To open the project to which the project security is set, the user authentication is required.
Input the registered user name and password to log in to the project.
To log in to the project with another user name, close the project and open it again.
If any password or user information is changed, the changes are effective in the next login.

(2) Package data transfer and the project security
(a) Writing the package data

The setting of the project security is written to the GOT with the package data.
If a project with the project security in the GOT is overwritten by writing package data with different project security into 
the GOT, the project security in the GOT is overwritten as well.
The project security can be set even after the package data is written to the GOT.

(b) Reading the package data
If the project security is set to a project in the GOT and the project is read from the GOT, the project security is read as 
well.
To open the project read from the GOT, the user authentication is required.
To restrict reading a project from the GOT, set a password for the data transfer beside the one for the project security.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Access Level
Access Privilege

Display Edit

Administrators Enable (fixed) Enable (fixed)

Developers(Level3) Select Enable or Disable. Select Enable or Disable.

Developers(Level2) Select Enable or Disable. Select Enable or Disable.

Developers(Level1) Select Enable or Disable. Select Enable or Disable.

Users Select Enable or Disable. Disable (fixed)
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(3) Canceling the project security
Deleting all the registered users cancels the project security.

➟2.13.2 ■3 (2) Deleting a user

■4 Restricting the project operation by the access authority

The following shows available operations and unavailable operations according to the user's access privilege.

(1) Operations for the project
(a) Display-allowed and edit-allowed users

The users can open the project to add, change, or delete screens or settings including the common setting and save the 
project.
The access privilege for the screen that has been newly added or overwritten is set as follows.

• The screen that has been newly added
The same access privilege set for the whole project is applied to the screen that has been newly added.

• The screen that has been overwritten
The same access privilege set for the screen that has been overwritten is applied to the target screen to be 
overwritten.

If the access authority is set for screens or scripts individually, the following operations are restricted.

(b) Display-allowed and edit-prohibited users
The users can open the project, but cannot add, change, and delete the settings and save the project.
Only the following operations are allowed for those users.

• Deleting a project
• Writing the package data to the GOT or the data storage
• Verifying projects between the GOT and GT Designer3
• Verifying the project being opened with the saved project
• Setting the project security
• Printing (Display-disabled screens or scripts cannot be printed.)

If the access authority is set for screens or scripts individually, the following operations are restricted.

(c) Display-prohibited and edit-prohibited users
The users cannot open the project.
The users cannot write the package data to the GOT or the data storage.

(2) Operations for the screens
(a) Display-allowed and edit-allowed users

The users can display, copy, change, and delete the screens.
If a screen to be displayed by the set overlay screen or in the window preview is display-disabled, a dummy screen will 
be displayed.
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Operation Restriction Condition

Changing the GOT type In the [GOT Type Setting] dialog, the change 
of [Type] cannot be determined.

The project includes a screen or a script that 
cannot be edited by the user who is logging in.

Changing the communication settings
In the [Controller Setting] window, the 
changes of [Manufacturer] and [Type] cannot 
be determined.

Verifying projects between the GOT and GT 
Designer3

The project in GT Designer3 cannot be 
verified with the one in the GOT. The project includes a screen or a script that 

cannot be displayed by the user who is 
logging in.Verifying the project being opened with the 

saved project
The project being opened cannot be verified 
with the saved project.

Operation Restriction Condition

Verifying projects between the GOT and GT 
Designer3

The project in GT Designer3 cannot be 
verified with the one in the GOT. The project includes a screen or a script that 

cannot be displayed by the user who is 
logging in.Verifying the project being opened with the 

saved project
The project being opened cannot be verified 
with the saved project.
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(b) Display-allowed and edit-prohibited users
The users can display and copy the screens, but cannot change or delete them.
The users can copy figures and objects on the screens, but cannot arrange, move, change, and delete them.
If a screen to be displayed by the set overlay screen or in the window preview is display-disabled, a dummy screen will 
be displayed.

(c) Display-prohibited and edit-prohibited users
The users cannot display, change, and delete the screens.
The information of the display-disabled screens is not displayed in the windows where the list of the settings is displayed 
such as the data browser.
The display-disabled screens are displayed when simulation is executed.

(3) Operations for the scripts
(a) Display-allowed and edit-allowed users

The users can display and change the script setting.
Even when the users are allowed to edit scripts, they cannot edit the screen script set on an edit-disabled screen.

(b) Display-allowed and edit-prohibited users
The user can display the script setting, but cannot add, change or delete the setting.

(c) Display-prohibited and edit-prohibited users
The user cannot display the script setting.
The information of the scripts is not displayed in the windows where the list of the settings is displayed such as the data 
browser.

(4) Operations for the libraries
Even the users who are not allowed to edit the project can register, change, and delete the library data.
2. CREATING A PROJECT
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2.13.2 How to use the project security

➟■1 For the first setting of the project security
■2 Logging in to the project
■3 User management (addition, deletion, and change)
■4 Setting an access privilege
■5 Changing a password

■1 For the first setting of the project security

First, register a user whose access level is Administrators.
Step 1 Select [Project] → [Security] → [User Management] from the menu to display the [User Addition] dialog.

(After the first user is registered, the [User Management] dialog is displayed by the operation above.)
Step 2 Set [User Name], [Access Level], [Password], [Re-enter Password] and click the [OK] button.

➟2.13.4 [User Addition] dialog
Step 3 The set user is registered and the user is logged in the project.
Step 4 Overwrite the project.

➟2.15.1 Overwriting a project
Step 5 Add other users and set the access privilege of them.

➟■3 User management (addition, deletion, and change)
■4 Setting an access privilege

User name and password management
Do not forget the user name and the password for Administrators.
If you do so, you cannot open the project.

■2 Logging in to the project

Step 1 Open the project with GT Designer3.

➟2.3.2 Opening a project
Step 2 The [User Authentication] dialog is displayed.

Input the user name and the password for logging in and click the [OK] button.

Step 3 When the user is authorized, the project opens.
The name of the user who is logged in the project is displayed on the status bar of GT Designer3.
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■3 User management (addition, deletion, and change)

Only the users who are allowed to edit the whole project can manage the user information.
The manageable range of users differs depending on the access level of the user who is logged in.

• Administrators
The user can add other users and change the user information over the full range of the access levels.

• Developers(Level3), Developers(Level2), or Developers(Level1)
The user can add other users or change the user information. However, the access level of the users to be added or 
changed must be lower than that of the user who is logged in.

• Users
The user cannot add other users and change the user information.

(1) Adding a user
Step 1 Select [Project] → [Security] → [User Management] from the menu to display the [User Management] dialog.

➟2.13.5 [User Management] dialog
Step 2 Click the [Add] button to display the [User Addition] dialog.

➟2.13.4 [User Addition] dialog
Step 3 Set [User Name], [Access Level], [Password], [Re-enter Password] and click the [OK] button to register the 

set user.
Step 4 Click the [OK] button in the [User Management] dialog to determine the setting.

(2) Deleting a user
Step 1 Select [Project] → [Security] → [User Management] from the menu to display the [User Management] dialog.

➟2.13.5 [User Management] dialog
Step 2 Select a user to be deleted and click the [Delete] button to delete the user.
Step 3 Click the [OK] button in the [User Management] dialog to determine the change.

(3) Changing the user information
Step 1 Select [Project] → [Security] → [User Management] from the menu to display the [User Management] dialog.

➟2.13.5 [User Management] dialog
Step 2 Select a user to be changed and click the [Replace] button to display the [Change User Data] dialog.

➟2.13.6 [Change User Data] dialog
Step 3 Set [User Name] and [Access Level] and click the [OK] button to change the user information.
Step 4 Click the [OK] button in the [User Management] dialog to determine the change.

■4 Setting an access privilege

Only the users who are allowed to edit the whole project can set the access privilege.
Step 1 Select [Project] → [Security] → [Setup Access Authority] from the menu to display the [Setup Access 

Authority] dialog.

➟2.13.7 [Setup Access Authority] dialog
Step 2 Set the access privilege and click the [OK] button to determine the setting.
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■5 Changing a password

Only the users who are allowed to edit the whole project can change the passwords.

(1) Changing the password of the user currently logging in
Step 1 Select [Project] → [Security] → [Change Password] from the menu to display the [Change Password] dialog.

➟2.13.8 [Change Password] dialog
Step 2 Set [Old Password], [New Password], and [Re-enter Password] and click the [OK] button to change the 

password.

(2) Changing the password of the user who is managed by the project
Step 1 Select [Project] → [Security] → [User Management] from the menu to display the [User Management] dialog.

➟2.13.5 [User Management] dialog
Step 2 Select the user whose password is to be changed and click the [Password change] button to display the 

[Change Password] dialog.

➟2.13.8 [Change Password] dialog
Step 3 Set [New Password] and [Re-enter Password] and click the [OK] button to change the password.
Step 4 Click the [OK] button in the [User Management] dialog to determine the change.

2.13.3 Precautions

■1 Protecting the script data
If the script data is stored to another file (external data), the script data is not protected.
To protect the script, store the script data in the project (internal data).

➟9.9.5 ■4 [Option] tab

■2 Protecting parts and scripts set for an edit-disabled screen
Even if users are disallowed to edit a screen, an edit-enabled part, script, or others set for the screen is not protected.

■3 Screen display for simulation
When simulation is executed, even the display-disabled screens are displayed.

■4 Converting the project security set by the old version of GT Designer3
If you convert a project in which the project security is set by GT Designer3 Version1.43V or older for GOT2000 series, 
the read-disabled setting is converted into the display-disabled setting, and the write-enabled setting into the edit-
disabled setting.

■5 When you forget a user name and a password
When you forget a password, log in to the project as the user whose access level is Administrators and change the 
password.
If you forget the user name and the password for the user whose access level is Administrators, you cannot open the 
project.
Delete the project and create a new project.
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2.13.4 [User Addition] dialog

1) [User Name]
Set a user name for authentication.
Up to 20 characters can be set.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&()*+,-./:;<=>?@[\]^_`{|}~
Capital letters and small letters are distinguished.
You cannot place a one-byte space at the end of a user name.
You cannot set a user name which is already registered.

2) [Access Level]
Select an access level for the user to be set.
The following shows the items to be selected.

For the first setting of the project security, the user access level is fixed to [Administrators].
The selectable range of the access levels differs depending on the access level of the user who is logged in.

• Administrators
The user can select one from all the access levels.

• Developers(Level3), Developers(Level2), or Developers(Level1)
The user can select an access level which is lower than that of the user who is logged in.

3) [Password]
Set a password for authentication.
The password must be between 6 to 32 characters.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
Capital letters and small letters are distinguished.
The input password is displayed as asterisks.

4) [Re-enter Password]
Input the same password as the one input in [Password].
The input password is displayed as asterisks.
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1)

2)

3)

4)

· Administrators

· Developers (Level 2)

· Developers (Level 3)

· Developers (Level 1)

· Users

High

Low
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2.13.5 [User Management] dialog

1) User list
Displays the user names and the access levels of the registered users.

2) [Number of User Registrations]
The number of the registered users

3) Management button
Use these buttons to manage the users.
The manageable range of users differs depending on the access level of the user who is logged in.

• Administrators
The user can add other users and change the user information over the full range of the access levels.

• Developers(Level3), Developers(Level2), or Developers(Level1)
The user can add other users or change the user information. However, the access level of the users to be 
added or changed must be lower than that of the user who is logged in.

Item Description

[Add] button
Displays the [User Addition] dialog. 
Click this button to add a user.
➟2.13.4 [User Addition] dialog

[Delete] button Deletes the user selected in the user list. 
Deleting all the registered users cancels the security setting.

[Replace] button
Displays the [Change User Data] dialog. 
You can change the access level and the password of the user selected in the user list.
➟2.13.6 [Change User Data] dialog

[Password Setup] button
Displays the [Change Password] dialog. 
You can change the password of the user selected in the user list.
➟2.13.8 [Change Password] dialog
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2.13.6 [Change User Data] dialog

1) [User Name]
Set a user name for authentication.
Up to 20 characters can be set.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&()*+,-./:;<=>?@[\]^_`{|}~
Capital letters and small letters are distinguished.
You cannot place a one-byte space at the end of a user name.
You cannot set a user name which is already registered.

2) [Access Level]
Select an access level for the user to be set.
The following shows the items to be selected.

The selectable range of the access levels differs depending on the access level of the user who is logged in.
• Administrators

The user can select one from all the access levels.
• Developers(Level3), Developers(Level2), or Developers(Level1)

The user can select an access level which is lower than that of the user who is logged in.
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1)

2)

· Administrators

· Developers (Level 2)

· Developers (Level 3)

· Developers (Level 1)

· Users

High

Low
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2.13.7 [Setup Access Authority] dialog

1) [Set per Target]
Allows you to set the access privilege for the base screens, window screens, report screens, mobile screens, or the 
whole of scripts.
Displays the targets for which the access privilege are set in the tree view in the access target list.

2) Access target list
Select a target for which the access privilege is set.

3) [Access Privilege]
Move each slider up and down to set an access privilege for a target selected from the access target list.

Item Description

Project

Set an access privilege for the whole project.
The display style of the project name differs depending on the project format.
• Workspace format: Project name
• Single file format: File name

[Base Screen], [Window Screen], [Report 
Screen], and [Mobile Screen]

Lists the base screens, window screens, report screens, and mobile screens.
The access privilege is settable for each screen.
To set the access privilege by screen type, select [Base Screen], [Window Screen], [Report 
Screen], or [Mobile Screen].

[Script]
Sets the same access privilege for the project scripts, screen scripts, script lists, and the 
whole script symbols.
This setting is not applied to script parts, object scripts, and object script symbols.

Item Description

[Display] Set a bottom access level for displaying the target selected in the access target list.

[Edit] Set a bottom access level for editing the target selected in the access target list.
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3)

1)

2)

Project
2 - 184 2. CREATING A PROJECT
2.13 Protecting a Project by Registering Users



2

C
R

EA
TI

N
G

 A
 P

R
O

JE
C

T

The settable range of the access privilege differs depending on the access level of the user who is logged in.
• Administrators

The user can set an access privilege for each target over the full range of the access levels.
• Developers(Level3), Developers(Level2), or Developers(Level1)

The user can set an access privilege for each target within the range of the access level of the user who is 
logged in or the lower level.

Example) For the user whose access level is Developers(Level2)

If the access privilege is set for the screens and scripts individually, only the user who is allowed to edit the screens 
or the scripts can change their access levels.

2.13.8 [Change Password] dialog

1) [Old Password]
Input the current password for authentication.
The input password is displayed as asterisks.

2) [New Password]
Set a new password.
The password must be between 6 to 32 characters.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
Capital letters and small letters are distinguished.
The input password is displayed as asterisks.

3) [Re-enter Password]
Input the same password as the one input in [New Password].
The input password is displayed as asterisks.

The setting range is Developers (Level 2) or lower.
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1)

2)

3)

2)

3)

When the password of a login user is changed
When the password of a user 

who is not logged in is changed
2. CREATING A PROJECT
2.13 Protecting a Project by Registering Users

2 - 185



2.14 Printing or Outputting a Project to a File

The settings and screen images of the created project can be printed or output to a file.
The data output to a file can be edited and used for each type of documents.

➟2.14.1 Specifications for printing and outputting files
2.14.2 How to print and output files
2.14.3 Precautions
2.14.4 [Page Settings] dialog
2.14.5 [Print Preview] window
2.14.6 [Print] dialog

2.14.1 Specifications for printing and outputting files

➟■1 Specifications for printing
■2 Specifications for outputting files

■1 Specifications for printing

The following shows the contents to be printed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Output of paper documents 
by a printer

File output

Print

Text file
Image file
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[Items for Print] Content to be printed

[Cover] Outputs the title, date, and/or other items set in the [Print] dialog.

[Screen Name] Outputs the screen title.

[Screen Image List] Outputs the list of the screen images.

[Screen Image/Setting] Outputs the screen properties and designs, the settings of the objects on the screens, and the startup logo 
image.

[Common] Outputs the project information and common settings (including type setting and controller setting).

[Recipe Setting] Outputs the recipe common setting and recipe setting.

[Logging Setting] Outputs the logging setting.

[Device Data Transfer] Outputs the device data transfer setting.

[Device] Outputs the list of the devices used in the project and the positions of each device.

[Label (GT Designer3)] Outputs the list of registered label groups, or the list of labels (GT Designer3) registered in a label group.

[Comment] Outputs the registered comments and attributes.

[Parts] Outputs the parts settings and details of the registered parts (part numbers, names, and images).

[Script] Outputs the script settings (script settings, script symbols, and script options).

[Sound] Outputs the sound file list and the touch key sound setting.

[Category] Outputs shapes, objects, and screen numbers and coordinates where each shape or object is arranged for 
each category.

[My Library] Outputs screen numbers, names, and images of the shapes and objects registered for each folder in my 
library.
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■2 Specifications for outputting files

(1) File formats for output
(a) Setting

The settings of the project can be output in the following formats.
• CSV format
• Unicode text format

(b) Screen image
The images of base screens, window screens, report screens, and mobile screens can be output in the following formats.

• BMP format
• JPEG format

(2) Files to be output
(a) Text file

The following table lists the targets to be output to a text file and those file names.
When [Add project name to the file name] is selected, the following is prepended to a file name.

• For a workspace format project: Project name
• For a single file format project: Project file name (excluding its extension .GTX)

Example) When [Cover] is selected for [Items for Print] and the project file name is "Project1.GTX"
In this case, the file name is "Project1-Cover.CSV" or "Project1-Cover.TXT".
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[Items for Print] Files to be output Content to be printed

[Cover] Cover.CSV/TXT Outputs the title, date, and other items set in the 
[Print] dialog.

[Screen Name] Screen Name.CSV/TXT Outputs the screen title.

[Screen Image/Setting] Screen Image Setting.CSV/TXT Outputs the screen properties and designs, and the 
settings of the objects on the screens.

[Common] Common Setting.CSV/TXT Outputs the project information and common settings 
(including type setting and controller setting).

[Recipe Setting]
Recipe Common.CSV/TXT Outputs the recipe common setting.

Recipe Setting-*****.CSV/TXT Outputs the recipe setting. 
[*****] indicates the recipe No. to be output.

[Logging Setting] Logging Setting-*****.CSV/TXT Outputs the logging setting. 
[*****] indicates the logging ID to be output.

[Device Data Transfer] Device Data Transfer-*****.CSV/TXT
Outputs the device data transfer setting. 
[*****] indicates the device data transfer ID to be 
output.

[Device] ([List])
Device List-CH*.CSV/TXT

Outputs the controller devices used in the project for 
each channel. 
[*] indicates CH No. to be output.

Device List-GOT.CSV/TXT Outputs the GOT internal devices used in the project.

[Device]([Detail])
Device Detail-CH*.CSV/TXT

Outputs the controller devices used in the project and 
the positions of each device for each channel. 
[*] indicates CH No. to be output.

Device Detail-GOT.CSV/TXT Outputs the GOT internal devices used in the project 
and the positions of each device.

[Label (GT Designer3)]

Label Group List.CSV/TXT Outputs the list of registered label groups.

Label Group-***.CSV/TXT
Outputs the list of labels (GT Designer3) registered in 
a label group. 
[***] indicates the label group number.

[Comment]
Comment List-***.CSV/TXT Outputs the registered comments. 

[***] indicates group No. to be output.

Comment List-***Attribute.CSV/TXT Outputs the comment attributes. 
[***] indicates group No. to be output.

[Parts] Parts.CSV/TXT Outputs the parts settings and details of the 
registered parts (part numbers and names).

[Script] Script.CSV/TXT Outputs the script settings (script settings, script 
symbols, and script options).
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(b) Image file
The following table lists the targets to be output to an image file and those file names.

[Sound] Sound Files.CSV/TXT Outputs the sound file list and the touch key sound 
setting.

[Category] Category.CSV/TXT
Outputs shapes, objects, and screen numbers and 
coordinates where each shape or object is arranged 
for each category.

[My Library] My Library.CSV/TXT Outputs screen numbers and names of the shapes 
and objects registered for each folder in my library.

[Items for Print] Files to be output Content to be printed

[Screen Image/Setting]
(Base screen)

Base ON-*****.BMP/JPEG Outputs the image of the ON-state base screen. 
[*****] indicates the screen number.

Base OFF-*****.BMP/JPEG Outputs the image of the OFF-state base screen. 
[*****] indicates the screen number.

Base ON Object ID-*****.BMP/JPEG
Outputs the image of the ON-state base screen with 
the object IDs visible. 
[*****] indicates the screen number.

Base OFF Object ID-*****.BMP/JPEG
Outputs the image of the OFF-state base screen with 
the object IDs visible. 
[*****] indicates the screen number.

Base ON Device-*****.BMP/JPEG
Outputs the image of the ON-state base screen with 
the devices visible. 
[*****] indicates the screen number.

Base OFF Device -*****.BMP/JPEG
Outputs the image of the OFF-state base screen with 
the devices visible. 
[*****] indicates the screen number.

[Screen Image/Setting]
(Window screen)

Window ON-*****.BMP/JPEG Outputs the image of the ON-state window screen. 
[*****] indicates the screen number.

Window OFF-*****.BMP/JPEG Outputs the image of the OFF-state window screen. 
[*****] indicates the screen number.

Window ON Object ID-*****.BMP/JPEG
Outputs the image of the ON-state window screen 
with the object IDs visible. 
[*****] indicates the screen number.

Window OFF Object ID-*****.BMP/JPEG
Outputs the image of the OFF-state window screen 
with the object IDs visible. 
[*****] indicates the screen number.

Window ON Device-*****.BMP/JPEG
Outputs the image of the ON-state window screen 
with the devices visible. 
[*****] indicates the screen number.

Window OFF Device-*****.BMP/JPEG
Outputs the image of the OFF-state window screen 
with the devices visible. 
[*****] indicates the screen number.

[Screen Image/Setting]
(Report screen)

Report-*****.BMP/JPEG Outputs the screen images of report screens. 
[*****] indicates the screen number.

Report Object ID-*****.BMP/JPEG
Outputs the image of a report screen with the object 
IDs visible. 
[*****] indicates the screen number.

Report Device-*****.BMP/JPEG
Outputs the image of a report screen with the devices 
visible. 
[*****] indicates the screen number.

[Items for Print] Files to be output Content to be printed
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[Screen Image/Setting]
(Mobile screen)

Mobile ON-*****.BMP/JPEG Outputs the image of the ON-state mobile screen. 
[*****] indicates the screen number.

Mobile OFF-*****.BMP/JPEG Outputs the image of the OFF-state mobile screen. 
[*****] indicates the screen number.

Mobile ON Object ID-*****.BMP/JPEG
Outputs the image of the ON-state mobile screen 
with the object IDs visible. 
[*****] indicates the screen number.

Mobile OFF Object ID-*****.BMP/JPEG
Outputs the image of the OFF-state mobile screen 
with the object IDs visible. 
[*****] indicates the screen number.

Mobile ON Device-*****.BMP/JPEG
Outputs the image of the ON-state mobile screen 
with the devices visible. 
[*****] indicates the screen number.

Mobile OFF Device-*****.BMP/JPEG
Outputs the image of the OFF-state mobile screen 
with the devices visible. 
[*****] indicates the screen number.

[Screen Image/Setting]
(Startup logo) Startup Logo.BMP or JPEG Outputs the image of the startup logo.

[Parts] Parts-*****.BMP/JPEG Outputs the images of the registered parts. 
[*****] indicates the parts number.

[My Library] My Library-***-***.BMP/JPEG

Outputs the images of the shape and objects 
registered in my library. 
[***-***] indicates [the library folder number - the 
library data number].

[Items for Print] Files to be output Content to be printed
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2.14.2 How to print and output files

■1 Setting the page layout or color tone
Step 1 Select [Project] → [Page Settings] from the menu to display the [Page Settings] dialog.

➟2.14.4 [Page Settings] dialog
Step 2 Click the [OK] button after the required settings to complete the setting.

■2 Outputting
Step 1 Select [Project] → [Print] from the menu to display the [Print] dialog.

➟2.14.6 [Print] dialog
Step 2 Click the [Print] button after setting output targets in [Items for Print] to display a dialog according to the 

setting of the output destination.
• For the printer output, the setting dialog to be displayed depends on the printer driver of the OS used.
• For the file output, the [Save Specified Folder] dialog is displayed.

Step 3 Output the pages by the following operations in the setting dialog.
• For the printer output, click the [OK] button after the required settings.
• For the file output, click the [Save] button after specifying the destination to save the file.

2.14.3 Precautions

■1 Outputting a project for which the project security is set
The screen for which displaying is prohibited cannot be output.

2.14.4 [Page Settings] dialog

➟■1 [Page Settings] tab
■2 [Screen Image] tab

■1 [Page Settings] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Margin (mm)]
Set page margins for each direction (up/down/left/right).
The setting range is [0] mm to [100] mm.

2) [Frame]
Select this item to display a frame in the page.
Click the [...] button to display the [Frame List] dialog.
Select a frame pattern.

3) [Initial Page No.]
Set an initial value of the page number.
The setting range is [1] to [9999].

4) [Header] tab, [Footer] tab
Switches the target to be set (header or footer).

• Frame list
Displays frame images.

• [Import] button
Imports frame images. 
The following shows available file formats for importing frame 
images.
• WMF format
• EMF format
The imported files are displayed in the frame list.

• [Delete] button
Deletes the selected frame from the frame list.

• [Replace Name] button
Changes the name of the selected frame in the frame list.

Item Description

[Left], [Center], [Right]

Set text to be displayed in the left side, center, or right side of the header or footer. 
Up to 512 characters including two lines can be set. A line feed is counted as two 
characters.
A line feed is counted as two characters. 
You can also select and input text from the auto-text list.

[Font]

Set a font name, text size, and an effect for the text displayed in the header or footer. The 
same font setting is applied to all the texts in [Left], [Center], and [Right].
• [Font Name]

Select a font.
• [Size]

Select a text size.
• Effect button

Set an effect for the text.

• [Bold] button
Boldifies the text.

•  [Italic] button
Leans the text.

•  [Underline] button
Underlines the text.

Frame list

Click the button to display the auto-text list.

[Underline] button
[Italic] button
[Bold] button

Effect button
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5) [Preview]
Displays a preview of the settings.

[Image]

Select this item to set an image file to be displayed in the header or footer. 
The image is displayed behind the text set in [Left], [Center], and [Right]. 
Click the [...] button to display the [Screen Selection] dialog. 
The BMP, JPEG, WMF, and EMF file formats can be read.
• [Position-Left]

Set the display position of the image in the horizontal direction with the origin at the left 
edge of the header area. 
The setting range is [-999.9mm] to [999.9mm].

• [Position-Up] 
Set the display position of the image in the vertical direction with the origin at the top edge 
of the header area. 
The setting range is [-999.9mm] to [999.9mm].

• [Magnification-Width], [Magnification-Height]
Set the display magnification of the image. 
The setting range is [0%] to [100%]. 
You can set whether to set the same value for both [Magnification-Width] and 
[Magnification-Height] or not.

• [Centering] button
Sets the display position of the image in the center of the header or footer.

Item Description

If set If not set

Switches between setting the same value and accepting individual value.
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■2 [Screen Image] tab

1) [Rev Setting]
Select the reverse processing of color tones of the screen image.
The following shows the items to be selected.

• [No Invert]
• [Invert]
• [Tone Invert]

2) [Fill the background of text in black]
Sets the text color to white and the background color to black for outputting the screen image.

3) [Dithering]
Sets the screen image to monochrome with the neutral color tone for outputting the screen image.

4) [Display comments with Preview No.]
Displays the comment of the comment column No. which is set as the preview number for outputting the screen 
image.
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PreviewView on the screen editor
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2.14.5 [Print Preview] window

1) Print button
Displays the [Print] dialog.

➟2.14.6 [Print] dialog
2) [Page Settings] button

Displays the [Page Settings] dialog.
➟2.14.4 [Page Settings] dialog

3) [First Page] button
Moves to the top page.

4) [Previous Page] button
Moves to the previous page.

5) [Page specification]
Displays the page whose preview image is currently displayed.
Press the [Enter] key after setting the page number to move to the set page.

6) [Next Page] button
Moves to the next page.

7) [Final Page] button
Moves to the last page.

8) [Size Specification]
Select a display size or display method of the pages.
The following shows the items to be selected.

• [400%]
• [300%]
• [200%]
• [150%]
• [100%]
• [75%]
• [50%]
• [25%]
• [10%]
• [Display All Page]
• [Adjust Width]
• [1Page display]
• [2Page display]
• [4Page display]
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• [8Page display]
9) [Close] button

Closes the [Print Preview] window.
10) Preview

A preview of the print image.
11) Status bar

Displays the GOT type and channel settings of the project.
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2.14.6 [Print] dialog

1) [Items for Print]
Set targets to be output.
For the details of the contents to be output, refer to the following.

➟2.14.1 Specifications for printing and outputting files
2) [Destination]

Select an output destination.

3) Setting of the print items
Setting items depend on the setting of [Items for Print].
For details, refer to the following.

➟■1 [Cover]
■2 [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen] of [Screen Image List]
■3 [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen] of [Screen Image/Setting]
■4 [Recipe Setting], [Logging Setting], [Device Data Tansfer], [Label (GT Designer3)], [Comment], and 
[Category]
■5 [Device]

Item Description

[Printer]
Sets the output destination to the printer. 
Click the [Printer Settings] button to configure the printer settings. 
The contents of the printer setting depend on the printer driver of the OS used.

[File]

Sets the output destination to the file. 
Select an output format of the settings of the project in [File Type]. 
The following shows the setting range.
• [CSV]: Outputs the settings in the CSV format.
• [TXT]: Outputs the settings in the Unicode text format.
Select an output format of the screen image in [Screen Type]. 
The following shows the setting range.
• [BMP]: Outputs the settings in the BMP format.
• [JPEG]: Outputs the settings in the JPEG format.

[Add project name to the file name] Adds a project file name at the beginning of the file name.
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Example) When printing the data of a specific screen out of multiple base screens
Select [Base Screen] from the subitems of [Screen Image/Setting] in [Items for Print], select the items 
to be printed for [Print Target] which is displayed on the right of the screen, and set the details.

4) [Page Settings] button
Displays the [Page Settings] dialog.

➟2.14.4 [Page Settings] dialog
5) [Print Preview] button

Displays the [Print Preview] window.
➟2.14.5 [Print Preview] window

6) [Print] button
Outputs the settings.

7) [Close] button
Closes the [Print] dialog.
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■1 [Cover]

1) [Print Target]
Set targets to be output.

2) Text
Input character strings to be displayed as the item selected in [Print Target].
Up to 512 characters including three lines can be set. A line feed is counted as two characters.
A line feed is counted as two characters.

3) [Today's Date] button
Displayed when [Date] is selected in [Print Target].
Input today's date.

4) [Font Name]
Select a font of the item selected in [Print Target].

5) [Size]
Set a text size of the item selected in [Print Target].

6) Effect button
Set an effect for the text.

7) [Position-Up]
Set the display position of the text in the vertical direction with the origin at the top edge of the print area.
The setting range is [0.0mm] to [999.9mm].

8) [Position-Horizontal]
Set the horizontal position of the text.

9) [Frame]
Displays a frame on the cover.
Click the [...] button to display the [Frame List] dialog.

• [Bold] button
Boldifies the text.

• [Italic] button
Leans the text.

• [Underline] button
Underlines the text.
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[Underline] button
[Italic] button
[Bold] button
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Select a frame pattern.

10) [Image]
Set an image file to be displayed on the cover.
Click the [...] button to display the [Screen Selection] dialog.
The BMP, JPEG, WMF, and EMF file formats can be read.

• [Position-Left]
Set the display position of the image in the horizontal direction with the origin at the left edge of the print area.
The setting range is [-999.9mm] to [999.9mm].

• [Position-Up]
Set the display position of the image in the vertical direction with the origin at the top edge of the print area.
The setting range is [-999.9mm] to [999.9mm].

• [Magnification-Width], [Magnification-Height]
Set the display magnification of the image.
The setting range is [0%] to [100%].
You can set whether to set the same value for both [Magnification-Width] and [Magnification-Height] or not.

• [Centering] button
Sets the display position of the image in the center of the print area.

11) [Cover Preview]
Displays a preview of the settings.

• Frame list
Displays frame images.

• [Import] button
Imports frame images.
The following shows available file formats for importing frame 
images.
• WMF format
• EMF format
The imported files are displayed in the frame list.

• [Delete] button
Deletes the selected frame from the frame list.

• [Replace Name] button
Changes the name of the selected frame in the frame list.

Frame list

If set If not set

Switches between setting the same value and accepting individual value.
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■2 [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen] of [Screen Image 
List]

1) [ON]
Sets the images of when the devices of each screen are on as the targets to be output.
This item can be set only when [Printer] is selected in [Destination].

2) [OFF]
Sets the images of when the devices of each screen are off as the targets to be output.
This item can be set only when [Printer] is selected in [Destination].

■3 [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen] of [Screen Image/
Setting]
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1) [Print Target]
Set targets to be output.

2) [Screen Setting]
Select this item to set the screen setting as the target to be output.

3) [Screen Image]
Select this item to set the screen image as the target to be output.

4) [Screen Size]
Select a size of the screen image to be output.
This item can be selected only when [Printer] is selected in [Destination].
The following shows the items to be selected.

• [Large]
• [Medium]
• [Small]
• [Based Upon Base Screen]:

Outputs the screen image in the same size as that of the setting of [Screen Size] in [Base Screen].
[Based Upon Base Screen] can be set only in [Window Screen] of [Screen Image / Setting].
When [Base Screen] in [Screen Image / Setting] is not selected, the screen image is output in the size of [Large].

5) [ON], [OFF]
Select these items to set the settings of when the devices of each screen are on or off as the targets to be output.

6) [Object Setting]
Select this item to set the object setting as the target to be output.

• [List]: Outputs the list of objects arranged on each screen.
• [Detail]: Outputs the detail settings of the objects and the figures (having the device setting) arranged on each 

screen.

Item Description

[Select All] button Selects all the items in [Print Target].

[Unselect] button Deselects all the items in [Print Target].

Item Description

[Print Object ID] Displays object IDs on the screen image.

[Print Devices] Displays devices on the screen image.

[Print Window Preview] Displays a preview of the window screen on the screen image. 
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■4 [Recipe Setting], [Logging Setting], [Device Data Tansfer], [Label (GT Designer3)], 
[Comment], and [Category]

1) [Print Target]
Set targets to be output.

Item Description

[Select All] button Selects all the items in [Print Target].

[Unselect] button Deselects all the items in [Print Target].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■5 [Device]

1) [Print Target]
Set targets to be output.

2) [List]
Select this item to set the device list as the target to be output.

3) [Detail]
Select this item to set the details of the devices as the targets to be output.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.15 Saving a Project

GT Designer3 saves a project in the following formats.
• Workspace format
• A single file format (*.GTX, *.GTXS)

➟2.15.1 Overwriting a project
2.15.2 Saving a project in the workspace or the single file format (*.GTX)
2.15.3 Saving a project in the single file format (*.GTXS) with system applications

2.15.1 Overwriting a project

Select [Project] → [Save] from the menu to overwrite a project.
However, when the currently edited project is in any of the following conditions, the [Save As Project] dialog is displayed.

• A project which has never been saved
• A single file format (*.GTXS, *.G2) project
• A project for the GOT1000 series which opened after converted to a project for the GOT2000 series

➟2.15.2 ■1 [Save As Project] dialog (workspace format)
2.15.2 ■2 [Save As Project] dialog (single file format)

2.15.2 Saving a project in the workspace or the single file format (*.GTX)

Step 1 Select [Project] → [Save As] from the menu to display the [Save As Project] dialog.
Switch the screens according to the saving format of the project.

• Workspace format: Save the project in the [Save As Project] dialog (workspace format).
➟■1 [Save As Project] dialog (workspace format)

• Single file format : Save the project in the [Save As Project] dialog (single file format).
➟■2 [Save As Project] dialog (single file format)

Step 2 Click the [Save] button after the required settings to save the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Manipulation of the setting file for calling the PX Developer function
When you save the project for GT SoftGOT2000 in the single file format (*.GTX), a setting file (*.dat) for 
calling the PX Developer function is created in the same folder.
Do not delete the setting file (*.dat).
If you copy or move the project to another folder, also copy or move the setting file (*.dat) to the folder.

(2) Operating on iQ Works
Save a project with a different name, a project cannot be saved with a different name.
Only overwriting is available.
To save a project with a different name, save the project with the workspace from MELSOFT Navigator.

■1 [Save As Project] dialog (workspace format)

1) [Save Folder Path]
Set the destination path to save the project.
The path can be set from the [Browse] button.
Do not save the project in the following path.

• <Installation path>\GTD3_2000\App
• <Installation path>\GTD3

2) [Workspace/Project List]
Displays a workspace and project which exist in the destination path to save the project.
If a workspace is double-clicked, the projects in the workspace are displayed.

3) [Workspace Name]
Set a workspace name to save the project.
When the set workspace does not exist in [Workspace/Project List], a workspace with the set name is created when 
the project is saved.

4) [Project Name]
Set a project name to be saved.
Up to 200 characters can be used for the total number of the characters of [Save Folder Path], [Workspace Name], 
and [Project Name].
"\" at the end of the project name is not counted as a character.
Click the [Save] button to save the project with the set project name.

5) [Switch to single file format project] button
Switches the dialog to the [Save As Project] dialog (single file format).

➟■2 [Save As Project] dialog (single file format)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [Save As Project] dialog (single file format)

1) [Save in]
Select the destination to save the project.
Do not save the project in the following path.

• <Installation path>\GTD3_2000\App
• <Installation path>\GTD3

2) File list
Lists files in the destination to save the project.

3) [File name]
Set a file name of the project to be saved.
Click the [Save] button to save the project with the set file name.

4) [Files of type]
Select a file type of the project to be saved.

• [Project Data(*.GTX)]
Saves a file in the single file format (*.GTX).
The single file format (*.GTX) files are displayed in the file list.
The file is displayed only when the [Save As Project] dialog (single file format) is opened by selecting [Project] 
→ [Save As] from the menu.

• [Package Data(*.GTXS)]
Saves a file in the single file format (*.GTXS).
The single file format (*.GTXS) files are displayed in the file list.
The file is displayed only when the [Save As Project] dialog (single file format) is opened by selecting [Project] 
→ [Save As Single File Format Project (Package Data)] from the menu.

5) [Switch to workspace format project] button
Switches the dialog to the [Save As Project] (workspace format) dialog.

➟■1 [Save As Project] dialog (workspace format)
The file is displayed only when the [Save As Project] dialog (workspace format) is opened by selecting [Project] → 
[Save As] from the menu.
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■3 Folder and file operations of the workspace format project

If you operate (migrate, rename, or delete) the folders or files in the workspace by using Windows Explorer or others, the 
project cannot be opened.
Operate a workspace format project by the following procedures on GT Designer3.

(1) Moving a project
Step 1 Open a project to be moved.
Step 2 Select [Project] → [Save As] from the menu to save the project in the destination folder.
Step 3 Delete the original project.

(2) Changing a project name
Step 1 Open the project to change the name.
Step 2 Select [Project] → [Save As] from the menu to save the project after changing the name.
Step 3 Delete the original project.

(3) Copying a project
Step 1 Open the project to be copied.
Step 2 Select [Project] → [Save As] from the menu to save the project after changing the name.

(4) Deleting a project
➟2.3.4 ■1 Deleting a workspace format project

2.15.3 Saving a project in the single file format (*.GTXS) with system applications

Step 1 Select [Project] → [Save Package Data] from the menu to display the [Save As Package] dialog.
Step 2 Set [File name] and click the [Save] button after the required settings to save the project.

(1) Saving the package data
The project in the single file format (*.GTXS) is saved as the package data with the system application and 
communication driver of GT Designer3 in which the project is saved.
When the project which was saved as the package data is edited and saved, the system application and 
communication driver of the package data are updated with the information of the system application and 
communication driver of the GT Designer3 which is used to save the project.
The functions which are not compatible with the GT Designer3 which is used to save the project are deleted.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.1 Specifications

➟3.1.1 Simulation-supported GOTs
3.1.2 Monitoring-supported Controllers
3.1.3 Available devices for monitoring
3.1.4 Simulation-supported/unsupported functions
3.1.5 Destination to save data

For the overview of the simulation function, refer to the following.
➟1.1 ■2 Simulation

GT Simulator3 requires the same operating environment as GT Designer3.
For details, refer to the following.

➟1.1.1 Operating environment

3.1.1 Simulation-supported GOTs

The following lists the GOTs that are compatible with simulation by GT Simulator3 Version1.

Display color
The actual display color on the GOT may differ from the display color on GT Simulator3.
Check the actual display color on the GOT by [Preview] in GT Designer3.
➟2.9.1 Displaying a preview

■1 GOT2000 series (GT27) simulator

*1 Capacity of the GOT user area where package data is stored.
*2 The following items are displayed in 16777216 colors.

• Parts display
• Parts movement
• Image file

■2 GOT2000 series (GT25) simulator

*1 Capacity of the GOT user area where package data is stored.
*2 The following items are displayed in 16777216 colors.

• Parts display
• Parts movement
• Image file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Name Resolution (dot) Display color Memory capacity *1

GT27**-X 1024 × 768 65536 colors *2 57 MB

GT27**-S 800 × 600 65536 colors *2 57 MB

GT27**-V 640 × 480 65536 colors *2 57 MB

GT2705-V 640 × 480 65536 colors *2 32 MB

Name Resolution (dot) Display color Memory capacity *1

GT25**-WX 1280 × 800 65536 colors *2 32 MB

GT25**-W 800 × 480 65536 colors *2 32 MB

GT25**-S 800 × 600 65536 colors *2 32 MB

GT25**-V 640 × 480 65536 colors *2 32 MB

GT2505-V 640 × 480 65536 colors *2 32 MB
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■3 GOT2000 series (GT23) simulator

*1 Capacity of the GOT user area where package data is stored.
*2 The following items are displayed in 16777216 colors.

• Parts display
• Parts movement
• Image file

■4 GOT2000 series (GT21) simulator

*1 Capacity of the GOT user area where package data is stored.
*2 The following items are displayed in 16777216 colors.

• Parts display
• Parts movement
• Image file

■5 GOT SIMPLE series (GS25, GS21) simulator

*1 Capacity of the GOT user area where package data is stored.
*2 The following items are displayed in 16777216 colors.

• Parts display
• Parts movement
• Image file

3.1.2 Monitoring-supported Controllers

➟■1 Controller simulator
■2 Mitsubishi Electric products
■3 Non-Mitsubishi Electric products

■1 Controller simulator

In this section, the controller simulator refers to the following software.
• GX Simulator
• GX Simulator2
• GX Simulator3
• MT Simulator2

GT Simulators3 connecting to the controller simulator enables monitoring the following virtual controllers.
Non-Mitsubishi Electric PLCs are handled as A4UCPU, and their specific devices cannot be monitored.
Non-Mitsubishi Electric PLCs are not supported by GX Simulator2 or GX Simulator3.

➟(1) Mitsubishi Electric products
(2) Non-Mitsubishi Electric PLCs

Name Resolution (dot) Display color Memory capacity *1

GT23**-V 640 × 480 65536 colors *2 10 MB

Name Resolution (dot) Display color Memory capacity *1

GT2107-W 800 × 480 65536 colors *2 15 MB

GT2105-Q 320 × 240 65536 colors *2 or 32-level 
monochrome

9 MB

GT2104-R 480 × 272 65536 colors *2 9 MB

GT2104-P 384 × 128 32-level monochrome 6 MB

GT2103-P 320 × 128 32-level monochrome 3 MB

Name Resolution (dot) Display color Memory capacity *1

GS25**-WX 1280 × 800 65536 colors *2 32 MB

GS21**-W-N 800 × 480 65536 colors *2 15 MB

GS21**-W 800 × 480 65536 colors *2 9 MB

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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For the devices that can be monitored by GT Simulator3, refer to the following.
➟3.1.3 Available devices for monitoring

(1) Mitsubishi Electric products

Type Model

RCPU*5

R00CPU R01CPU R02CPU R04CPU

R08CPU R16CPU R32CPU R120CPU

R08PCPU *11 R16PCPU *11 R32PCPU *11 R120PCPU *11

R08SFCPU R16SFCPU R32SFCPU R120SFCPU

R08PSFCPU R16PSFCPU R32PSFCPU R120PSFCPU

R04ENCPU R08ENCPU R16ENCPU R32ENCPU

R120ENCPU

R12CCPU-V *8

LHCPU *5 L04HCPU L08HCPU L16HCPU L32HCPU

QCPU*7
QCPU (Q Mode)

Q00JCPU Q00CPU Q01CPU Q02CPU

Q02HCPU Q06HCPU Q12HCPU Q25HCPU

Q02PHCPU *2 Q06PHCPU *2 Q12PHCPU *2 Q25PHCPU *2

Q12PRHCPU *2 Q25PRHCPU *2

Q00UJCPU Q00UJCPU-S8 Q00UCPU Q01UCPU

Q02UCPU Q03UDCPU Q04UDHCPU Q06UDHCPU

Q10UDHCPU Q13UDHCPU Q20UDHCPU Q26UDHCPU

Q03UDECPU Q04UDEHCPU Q06UDEHCPU Q10UDEHCPU

Q13UDEHCPU Q20UDEHCPU Q26UDEHCPU Q50UDEHCPU

Q100UDEHCPU

Q03UDVCPU*1 Q04UDVCPU*1 Q06UDVCPU*1 Q13UDVCPU*1

Q26UDVCPU*1

Q04UDPVCPU*1 Q06UDPVCPU*1 Q13UDPVCPU*1 Q26UDPVCPU*1

QCPU(A Mode)*2 Q02CPU-A Q02HCPU-A Q06HCPU-A

LCPU*1*7

L02CPU L02CPU-P L02SCPU L02SCPU-P

L06CPU L06CPU-P L26CPU L26CPU-BT

L26CPU-P L26CPU-PBT

QnACPU*2*7
QnACPU type

Q2ACPU Q2ACPU-S1 Q3ACPU Q4ACPU

Q4ARCPU

QnASCPU type Q2ASCPU Q2ASCPU-S1 Q2ASHCPU Q2ASHCPU-S1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
3 - 4 3. SIMULATION
3.1 Specifications



3

SI
M

U
LA

TI
O

N

*1 GX Simulator does not support the CPU.
*2 GX Simulator2 does not support the CPU.
*3 MT Simulator2 does not support the CPU.
*4 Only the PLC CPU area (CPU No.1) can be connected.
*5 To perform a simulation using GX Simulator or GX Simulator2, set the CPU as a QCPU. In this case, only the devices of 

QCPU can be simulated.
*6 To perform a simulation using GX Simulator or GX Simulator2, set the CPU as a Q03UDCPU.
*7 GX Simulator3 does not support the CPU.
*8 To perform a simulation using GX Simulator3, set the CPU as an RCPU. In this case, only the devices of RCPU can be 

simulated.
*9 To perform a simulation using GX Simulator or GX Simulator2, set the CPU as an FX3GCPU.
*10 To perform a simulation using GX Simulator, set the controller as a Q4ACPU.
*11 The MELSEC redundant system is configurable by mounting the redundant function module (R6RFM).
*12 Not available to GT21 and GS21.

The following shows the versions of the controller simulators or the software applications in which controller simulators 
are included.

(a) GX Simulator

ACPU*2*7

AnCPU type

AnUCPU A2UCPU A2UCPU-S1 A3UCPU A4UCPU

AnACPU

A2ACPU A2ACPUP21 A2ACPUR21 A2ACPU-S1

A2ACPUP21-S1 A2ACPUR21-S1 A3ACPU A3ACPUP21

A3ACPUR21

AnNCPU

A1NCPU A1NCPUP21 A1NCPUR21 A2NCPU

A2NCPUP21 A2NCPUR21 A2NCPU-S1 A2NCPUP21-S1

A2NCPUR21-S1 A3NCPU A3NCPUP21 A3NCPUR21

AnSCPU type

AnUS(H)CPU A2USCPU A2USCPU-S1 A2USHCPU-S1

AnS(H)CPU
A1SCPU A1SCPU-S1 A1SCPUC24-R2 A2SCPU

A1SHCPU A2SHCPU

A1SJ(H)CPU A1SJCPU A1SJCPU-S3 A1SJHCPU

A1FXCPU A1FXCPU

A0J2HCPU A0J2HCPU

A2CCPU A2CCPU A2CCPUC24 A2CJCPU

MELSEC iQ-F*5 FX5U FX5UC FX5UJ

FXCPU*7

FX0 series FX0N series FX0S series

FX1 series FX1N series FX1NC series FX1S series

FX2 series FX2C series FX2N series FX2NC series

FX3G series FX3GC series*1 FX3GE series*1*2*9

FX3U series FX3UC series FX3S series*1

MELSECNET/H remote I/O station*7 QJ72LP25-25 QJ72LP25G QJ72BR15

Motion CPU*7

Q series*1*2
Q170MCPU*3*4*6 Q170MSCPU*3*4*6 Q170MSCPU-S*3*4*6

Q172DSCPU Q173DSCPU

A series*2*3
A171SHCPU A172SHCPU A173UHCPU A173UHCPU-S1

A273UHCPU A273UHCPU-S3

MELIPC *5*8 MI5122-VW

CNC*12

CNC C80*5*8 R16NCCPU-S1

CNC C70*5*7 Q173NCCPU

MELDAS C6/
C64*2*7*10 FCA C6 FCA C64

Robot controller
CR800-R

(R16RTCPU)*5*8 CR800-D*5*8
CRnQ-700

(Q172DRCPU)*7
CR800-Q

(Q172DSRCPU) *5*7

PLC CPU compatible with simulation Version of GX Simulator

QCPU (A mode), ACPU, Motion CPU (A series) Version5.00A or later

Type Model
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(b) GX Simulator2

(c) GX Simulator3

*1 When global labels are set, use GX Works3 version 1.040S or later.

QnACPU Version5.40E or later

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC series, 
FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series Version5.40E or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version5.40E or later

Q00JCPU, Q00CPU, Q01CPU Version6.00A or later

Q02PHCPU, Q06PHCPU Version7.20W or later

Q12PHCPU, Q25PHCPU Version6.10L or later

Q12PRHCPU, Q25PRHCPU Version6.20W or later

FX3U series, FX3UC series Version7.08J or later

FX3G series Version7.22Y or later

Q00UJCPU, Q00UJCPU-S8, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, 
Q04UDHCPU, Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, 
Q26UDHCPU, Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, Q26UDEHCPU

Version7.23Z or later

PLC CPU compatible with simulation Version of GX Works2

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC series, 
FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series Version1.24A or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version1.12N or later

Q00JCPU, Q00CPU, Q01CPU Version1.12N or later

QnPHCPU Version1.87R or later

FX3U , FX3UC, FX3G series Version1.24A or later

FX3GC series Version1.77F or later

FX3S series Version1.492N or later

Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 
Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 
Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU, 
Q20UDEHCPU, Q26UDEHCPU

Version1.12N or later

Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU Version1.492N or later

L02CPU, L26CPU-BT Version1.24A or later

L02CPU-P, L26CPU-PBT Version1.62Q or later

L06CPU Version1.98C or later

L02SCPU, L26CPU Version1.98C or later

L02SCPU-P, L06CPU-P, L26CPU-P Version1.492N or later

Q50UDEHCPU, Q100UDEHCPU Version1.31H or later

PLC CPU compatible with simulation Version of GX Works3

R00CPU, R01CPU, R02CPU Version1.045X or later

R04CPU, R08CPU, R16CPU, R32CPU, R120CPU Version1.007H or later*1

R08PCPU, R16PCPU, R32PCPU, R120PCPU Version1.010L or later*1

R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU Version1.020W or later*1

R08PSFCPU, R16PSFCPU, R32PSFCPU, R120PSFCPU Version1.045X or later

R04ENCPU, R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU Version1.020W or later*1

L04HCPU, L08HCPU, L16HCPU Version1.065T or later

L32HCPU Version1.295H or later

FX5U series, FX5UC series Version1.025B or later

FX5UJ Version1.065T or later

PLC CPU compatible with simulation Version of GX Simulator
3 - 6 3. SIMULATION
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(d) MT Simulator2

(2) Non-Mitsubishi Electric PLCs

The following lists available PLCs.
• OMRON PLC
• KEYENCE PLC

• KOYO EI PLC*2

• JTEKT PLC*2

• SHARP PLC*2

• TOSHIBA PLC*2

• SHIBAURA MACHINE PLC
• Panasonic IDS PLC

• HITACHI IES PLC*2

• HITACHI PLC*2*4

• FUJI PLC
• YASKAWA PLC
• YASKAWA robot controller

• YOKOGAWA PLC*2*3

• ALLEN-BRADLEY PLC*1

• GE PLC*2

• LS IS PLCS
• SICK PLC
• SIEMENS PLC

*1 When simulated by GX Simulator, bit devices and word devices cannot be monitored.
Only internal devices can be monitored.

*2 The GT21 and GS21 simulators cannot monitor the devices of the PLC.
*3 The multiple CPU system cannot be monitored.
*4 S10VE cannot be monitored.

Motion CPU compatible with simulation Version of MT Works2

Q172DSCPU, Q173DSCPU Version1.70Y or later

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Mitsubishi Electric products

The following shows Mitsubishi Electric products that can be monitored by GT Simulator3.

Type Model

RCPU

R00CPU R01CPU R02CPU R04CPU

R08CPU R16CPU R32CPU R120CPU

R08PCPU *6 R16PCPU *6 R32PCPU *6 R120PCPU *6

R08SFCPU R16SFCPU R32SFCPU R120SFCPU

R08PSFCPU *11 R16PSFCPU *11 R32PSFCPU *11 R120PSFCPU *11

R04ENCPU *12 R08ENCPU *12 R16ENCPU *12 R32ENCPU *12

R120ENCPU *12

R12CCPU-V *4

LHCPU L04HCPU L08HCPU L16HCPU L32HCPU

QCPU
QCPU (Q mode)

Q00JCPU Q00CPU Q01CPU Q02CPU

Q02HCPU Q06HCPU Q12HCPU Q25HCPU

Q02PHCPU Q06PHCPU Q12PHCPU Q25PHCPU

Q12PRHCPU Q25PRHCPU

Q00UJCPU Q00UJCPU-S8 Q00UCPU Q01UCPU

Q02UCPU Q03UDCPU Q04UDHCPU Q06UDHCPU

Q10UDHCPU Q13UDHCPU Q20UDHCPU Q26UDHCPU

Q03UDECPU Q04UDEHCPU Q06UDEHCPU Q10UDEHCPU

Q13UDEHCPU Q20UDEHCPU Q26UDEHCPU Q50UDEHCPU

Q100UDEHCPU

Q03UDVCPU Q04UDVCPU Q06UDVCPU Q13UDVCPU

Q26UDVCPU

Q04UDPVCPU Q06UDPVCPU Q13UDPVCPU Q26UDPVCPU

QCPU (A mode) Q02CPU-A Q02HCPU-A Q06HCPU-A

LCPU

L02CPU L02CPU-P L02SCPU L02SCPU-P

L06CPU L06CPU-P L26CPU L26CPU-BT

L26CPU-P L26CPU-PBT

QnACPU
QnACPU type

Q2ACPU Q2ACPU-S1 Q3ACPU Q4ACPU

Q4ARCPU

QnASCPU type Q2ASCPU Q2ASCPU-S1 Q2ASHCPU Q2ASHCPU-S1

ACPU

AnCPU type

AnUCPU A2UCPU A2UCPU-S1 A3UCPU A4UCPU

AnACPU

A2ACPU A2ACPUP21 A2ACPUR21 A2ACPU-S1

A2ACPUP21-S1 A2ACPUR21-S1 A3ACPU A3ACPUP21

A3ACPUR21

AnNCPU

A1NCPU A1NCPUP21 A1NCPUR21 A2NCPU

A2NCPUP21 A2NCPUR21 A2NCPU-S1 A2NCPUP21-S1

A2NCPUR21-S1 A3NCPU A3NCPUP21 A3NCPUR21

AnSCPU type

AnUS(H)CPU A2USCPU A2USCPU-S1 A2USHCPU-S1

AnS(H)CPU
A1SCPU A1SCPU-S1 A1SCPUC24-R2 A2SCPU

A1SHCPU A2SHCPU

A1SJ(H)CPU A1SJCPU A1SJCPU-S3 A1SJHCPU

A1FXCPU A1FXCPU

A0J2HCPU A2CCPU A2CCPUC24 A2CJCPU

MELSEC iQ-F FX5U FX5UC FX5UJ

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 Only the PLC CPU area (CPU No.1) can be connected.
*2 Only the devices of A2SHCPU can be monitored.
*3 Only the devices of A3UCPU can be monitored.
*4 Monitor the module via an RCPU in the multiple CPU system.
*5 Monitor the module via a QCPU in the multiple CPU system.
*6 The MELSEC redundant system is configurable by mounting the redundant function module (R6RFM).
*7 Monitor the controller via a Motion CPU in the multiple CPU system.

Use a MELSEC iQ-R series Motion CPU.
*8 Monitor the controller via a MELSEC iQ-R or MELSEC iQ-F series simple motion module.
*9 Not available to GT21.
*10 For the direct CPU connection (serial), use the serial port of the QCPU in a multiple CPU system.
*11 To monitor the module, a SIL2 function module and a redundant function module are required.
*12 The multiple CPU system cannot be monitored.

For the devices that can be monitored by GT Simulator3, refer to the following.
➟3.1.3 Available devices for monitoring

FXCPU

FX0 series FX0N series FX0S series

FX1 series FX1N series FX1NC series FX1S series

FX2 series FX2C series FX2N series FX2NC series

FX3G series FX3GC series FX3GE series

FX3U series FX3UC series FX3S series

MELSECNET/H remote I/O station QJ72LP25-25 QJ72LP25G QJ72BR15

CC-Link IE Field Network head unit RJ72GF15-T2 LJ72GF15-T2

Motion CPU

MELSEC iQ-R 
series R16MTCPU R32MTCPU R64MTCPU

Q series Q170MCPU *1 Q170MSCPU *1 Q170MSCPU-S1 *1

A series
A171SHCPU *2 A172SHCPU *2 A173UHCPU *3 A173UHCPU-S1 *3

A273UHCPU *3 A273UHCPU-S3 *3

CNC*9

CNC C80 *4 R16NCCPU-S1

CNC C70 *5 Q173NCCPU

MELDAS C6/C64 FCA C6 FCA C64

Robot controller
CR800-R

(R16RTCPU) *4
CRnQ-700

(Q172DRCPU) *10
CR800-Q

(Q172DSRCPU) *5

MELSERVO-J4 *7*8 MR-J4(W)-*B(-RJ)

MELSERVO-JE *8 MR-JE-*B MR-JE-*BF

Type Model
3. SIMULATION
3.1 Specifications
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■3 Non-Mitsubishi Electric products

The following shows the PLC CPUs that can be monitored by GT Simulator3.
➟(1) OMRON PLC CPU

(1) OMRON PLC CPU

*1 Simulation is available only by using the direct CPU connection (RS-232).
*2 GX Simulator can be used instead of GT Simulator3.

However, when GX Simulator is used, the set devices are handled as the ones of A4UCPU, and OMRON original devices 
are ignored.

To connect the PLC CPU to GT Simulator3, set the PLC CPU as follows.* 1

*1 For the setting of the PLC CPU, refer to the following.

➟GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) For GT Works3 Version1

For the devices that can be monitored by GT Simulator3, refer to the following.
➟3.1.3 Available devices for monitoring

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Type Model

PLC CPU*1*2

CPM2A

C200HX C200HG C200HE

CQM1 CQM1H

CS1H CS1G CS1D

CJ1H CJ1G CJ1M CJ2H

CJ2M

CP1E

CV500 CV1000 CV2000

CVM1

Item Set value

Baud rate 9600 bps

Data length 7 bits

Stop bit 2 bits

Parity Even number

Communicating condition format Individual setting

Host link station No. 00
3 - 10 3. SIMULATION
3.1 Specifications
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3.1.3 Available devices for monitoring

➟■1 When connected to the controller simulator
■2 Connecting with Mitsubishi Electric products
■3 Connecting with non-Mitsubishi Electric products

■1 When connected to the controller simulator

This section explains the devices that can be monitored by GT Simulator3 when the GOT is connected to a controller 
simulator.
For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 Monitoring-supported Controllers

(1) Mitsubishi Electric products
Devices that satisfy all of the following conditions can be monitored.

(2) OMRON PLC (OMRON SYSMAC)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller
*2 Except for the data link relay, auxiliary memory relay, holding relay, and internal auxiliary relay

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Condition Reference

Devices supported by the controller simulator
➟GX Simulator Version □ Operating Manual
GX Works2 Version □ Operating Manual (Common)
GX Works3 Operating Manual
MT Developer2 Help

Devices that can be monitored by the GOT
(Except the timer set value (TS) and counter set value (CS) of the 
Mitsubishi Electric PLC)

➟12.3 Device Range and Settings of Mitsubishi Electric Equipment

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

I/O relay/Internal auxiliary 
relay (..) ..000000 to ..614315 ..000000 to ..008115

Data link relay (LR) LR00000 to LR19915 LR00000 to LR08115

Auxiliary memory relay (AR) AR00000 to AR95915 -

Holding relay (HR) HR00000 to HR51115 HR00000 to HR08115

Internal auxiliary relay/Work 
relay (WR) WR00000 to WR51115 WR00000 to WR08115

Timer contact (TIM) TIM0000 to TIM4095 TIM0000 to TIM0255

Counter contact (CNT) CNT0000 to CNT4095 CNT0000 to CNT0255

Bit-specified word device*2 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

I/O relay/Internal auxiliary 
relay (..) ..0000 to ..6143 ..0000 to ..0081

Data link relay (LR) LR000 to LR199 LR000 to LR081

Auxiliary memory relay (AR) AR000 to AR959 -

Holding relay (HR) HR000 to HR511 HR000 to HR081

Internal auxiliary relay/Work 
relay (WR) WR000 to WR511 WR000 to WR081

Data memory (DM) DM00000 to DM32767 DM0000 to DM8191

Timer (current value) (TIM) TIM0000 to TIM4095 TIM0000 to TIM0255

Counter (current value) 
(CNT) CNT0000 to CNT4095 CNT0000 to CNT0255

Extended data memory (EM 
current bank) EM00000 to EM32767 -

Extended data memory (EM 
banks 0 to 13) E000000 to E032767 -
3. SIMULATION
3.1 Specifications
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(3) OMRON PLC (OMRON SYSMAC CS/CJ)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller
*2 Except for the data link relay, auxiliary memory relay, holding relay, and internal auxiliary relay

(4) KEYENCE PLC (KEYENCE KV-700/1000/3000/5000/7000/8000)

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

I/O relay/Internal auxiliary 
relay (..) ..000000 to ..614315 ..000000 to ..008115

Data link relay (LR) LR00000 to LR19915 LR00000 to LR08115

Auxiliary memory relay (AR) AR00000 to AR147115 AR1000000 to 
AR1153515 -

Holding relay (HR) HR00000 to HR51115 HR00000 to HR08115

Internal auxiliary relay/Work 
relay (WR) WR00000 to WR51115 WR00000 to WR08115

Timer contact (TIM) TIM0000 to TIM4095 TIM0000 to TIM0255

Counter contact (CNT) CNT0000 to CNT4095 CNT0000 to CNT0255

Bit-specified word device*2 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

I/O relay/Internal auxiliary 
relay (..) ..0000 to ..6143 ..0000 to ..0081

Data link relay (LR) LR000 to LR199 LR000 to LR081

Auxiliary memory relay (AR) AR000 to AR959 -

Holding relay (HR) HR000 to HR511 HR000 to HR081

Internal auxiliary relay/Work 
relay (WR) WR000 to WR511 WR000 to WR081

Data memory (DM) DM00000 to DM32767 DM0000 to DM8191

Timer (current value) (TIM) TIM0000 to TIM4095 TIM0000 to TIM0255

Counter (current value) 
(CNT) CNT0000 to CNT4095 CNT0000 to CNT0255

Extended data memory (EM 
current bank) EM00000 to EM32767 -

Extended data memory (EM 
banks 0 to 13) E000000 to E032767 -

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Relay (..) ..000000 to ..199915 ..00000 to ..51115

Internal AUX relay (MR) MR000000 to MR399915 MR00000 to MR51115

Latch relay (LR) LR00000 to LR99915 LR00000 to LR51115

Control relay (CR) CR0000 to CR8915 CR0000 to CR1515

Link relay (B) B0000 to B7FFF -

Work relay (VB) VB0000 to VBF9FF -

Timer (contact) (T) T0000 to T3999 T0000 to T0255

Counter (contact) (C) C0000 to C3999 C0000 to C0255

High-speed counter 
comparators (contact) (CTC) CTC0 to CTC7 -

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device
3 - 12 3. SIMULATION
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*1 Except for the timer (current value), timer (set value), counter (current value), counter (set value), high-speed counter 
(current value), high-speed counter comparators (set value), control memory, temporary data memory, index register, and 
digital trimmer

*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Word device

Data memory (DM) DM00000 to DM65534 DM0000 to DM8191

Extension data memory (EM) EM00000 to EM65534 -

Extension data memory 2 
(FM) FM00000 to FM32767 -

File register (ZF)

ZF000000 to ZF032767
ZF032768 to ZF065535
ZF065536 to ZF098303
ZF098304 to ZF131071
ZF131072 to ZF163839
ZF163840 to ZF196607
ZF196608 to ZF229375
ZF229376 to ZF262143
ZF262144 to ZF294911
ZF294912 to ZF327679
ZF327680 to ZF360447
ZF360448 to ZF393215
ZF393216 to ZF425983
ZF425984 to ZF458751
ZF458752 to ZF491519
ZF491520 to ZF524287

-

Link register (W) W0000 to W7FFF -

Control memory (CM) CM00000 to CM11998 -

Temporary data memory 
(TM) TM000 to TM511 -

Work memory (VM) VM00000 to VM63999 -

Index register (Z) Z01 to Z12 Z01 to Z06

Double word 
device

Timer (current value) (TC) TC0000 to TC3999 TC0000 to TC0254

Timer (set value) (TS) TS0000 to TS3999 -

Counter (current value) (CC) CC0000 to CC3999 CC0000 to CC0254

Counter (set value) (CS) CS0000 to CS3999 -

High-speed counter (current 
value) (CTH) CTH0 to CTH3 -

High-speed counter 
comparators (set value) 
(CTC)

CTC0 to CTC7 -

Index register (DZ) DZ01 to DZ12 -

Digital trimmer (TRM) TRM0 to TRM7 -

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)
3. SIMULATION
3.1 Specifications
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(5) KOYO EI PLC (KOYO KOSTAC/DL)
Not available to GT21 and GS21.

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input (I) I0 to I1777 I0 to I1777

Output (Q) Q0 to Q1777 Q0 to Q1777

Link relay (GI) GI0 to GI3777 GI0 to GI3777

Link output (GQ) GQ0 to GQ3777 -

Internal relay (M) M0 to M3777 M0 to M3777

Stage (S) S0 to S1777 -

Timer (T) T0 to T377 T0 to T377

Counter (C) C0 to C377 C0 to C377

Special relay (SP) SP0 to SP777 -

Word device

Timer (current value) (R) R0 to R377 R0 to R377

Preparatory register (R) R400 to R677 R400 to R677

Special register 1 (R) R700 to R777 R700 to R777

Counter (current value) (R) R1000 to R1377 R1000 to R1377

Data register 1 (R) R1400 to R7377 R1400 to R7377

Special register 2 (R) R7400 to R7777 R7400 to R7777

Data register 2 (R) R10000 to R36777 R10000 to R36777

Special register 3 (R) R37000 to R37777 R37000 to R37777

Link relay (R) R40000 to R40177 R40000 to R40177

Link output (R) R40200 to R40377 R40200 to R40377

Input (R) R40400 to R40477 R40400 to R40477

Output (R) R40500 to R40577 R40500 to R40577

Internal relay (R) R40600 to R40777 R40600 to R40777

Stage (R) R41000 to R41077 R41000 to R41077

Timer (R) R41100 to R41117 R41100 to R41117

Counter (R) R41140 to R41157 R41140 to R41157

Special relay (R) R41200 to R41237 R41200 to R41237
3 - 14 3. SIMULATION
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(6) JTEKT PLC (JTEKT TOYOPUC-PC)
Not available to GT21 and GS21.

*1 Except for the extended buffer register and setup value register
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input (X) X000 to X7FF X000 to X7FF

Output (Y) Y000 to Y7FF Y000 to Y7FF

Link relay (L) L000 to L7FF L000 to L7FF

Internal relay (M) M000 to M7FF M000 to M7FF

Keep relay (K) K000 to K2FF -

Edge detection (P) P000 to P1FF -

Timer (T) T000 to T1FF T000 to T1FF

Counter (C) C000 to C1FF C000 to C1FF

Special relay (V) V000 to V0FF -

Extended input (EX) EX000 to EX7FF -

Extended output (EY) EY000 to EY7FF -

Extended internal relay (EM) EM0000 to EM1FFF -

Extended keep-relay (EK) EK000 to EKFFF -

Extended special relay (EV) EV000 to EVFFF -

Extended timer (ET) ET000 to ET7FF -

Extended counter (EC) EC000 to EC7FF -

Extended link relay (EL) EL0000 to EL1FFF -

Extended edge detection 
(EP) EP000 to EPFFF -

Extended input 2 (GX) GX0000 to GXFFFF -

Extended output 2 (GY) GY0000 to GYFFFF -

Extended internal relay (GM) GM0000 to GMFFFF -

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

Data register (D) D0000 to D2FFF D0000 to D2FFF

Link register (R) R0000 to R07FF R0000 to R07FF

Setup value register (N) N0000 to N01FF N0000 to N01FF

Special register (S) S0000 to S03FF -

File register (B) B0000 to B1FFF B0000 to B1FFF

Extended present value 
register (EN) EN0000 to EN07FF -

Extended setup value 
register (H) H0000 to H07FF -

Extended special register 
(ES) ES0000 to ES07FF -

Extended data register (U) U0000 to U7FFF -

Extended buffer register (EB)
EB00000 to EB07FFF EB08000 to 
EB0FFFF EB10000 to EB17FFF 
EB18000 to EB1FFFF

-

Setup value register (TCS) TCS0000 to TCS01FF -

Word-specified bit devices Monitoring available range of each bit 
device Monitoring available range of each bit device
3. SIMULATION
3.1 Specifications
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(7) SHARP PLC (SHARP JW)
Not available to GT21 and GS21.

*1 Except for the timer and counter.
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

I/O relay ..00000 to ..15777 ..20000 to ..75777 ..00000 to ..15777

Timer (contact) (T) T0000 to T1777 T0000 to T0377

Counter (contact) C0000 to C1777 C0000 to C0377

Bit-specified word device Monitoring available range of each word 
device Monitoring available range of each word device

Word device

Timer (present value) (T) T0000 to T1777 T0000 to T0377

Counter (current value) (C) C0000 to C1777 C0000 to C0377

Register (09 to E7)

09000 to 09776 09000 to 09776

19000 to 19776 19000 to 19776

29000 to 29776 29000 to 29776

39000 to 39776 39000 to 39776

49000 to 49776 49000 to 49776

59000 to 59776 59000 to 59776

69000 to 69776 69000 to 69776

79000 to 79776 79000 to 79776

89000 to 89776 89000 to 89776

99000 to 99776 99000 to 99776

E0000 to E0776 E0000 to E0776

E1000 to E1776 E1000 to E1776

E2000 to E2776 E2000 to E2776

E3000 to E3776 E3000 to E3776

E4000 to E4776 E4000 to E4776

E5000 to E5776 E5000 to E5776

E6000 to E6776 -

E7000 to E7776 E7450 to E7776

File register (1 to 7)

1000000 to 1177776 2000000 to 2177776 
3000000 to 3177776 4000000 to 4177776 
5000000 to 5177776 6000000 to 6177776 
7000000 to 7177776

-

Word-specified bit devices*1 Monitoring available range of each bit 
device Monitoring available range of each bit device
3 - 16 3. SIMULATION
3.1 Specifications



3

SI
M

U
LA

TI
O

N

(8) TOSHIBA PLC
Not available to GT21 and GS21.

(a) TOSHIBA PROSEC T/V

*1 Except for the data register (D), link register (W), and file register (F)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(b) TOSHIBA Unified Controller nv

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

External input (X) X0000 to X511F X0000 to X511F

External output (Y) Y0000 to Y511F Y0000 to Y511F

Internal relay (R) R0000 to R4095F R0000 to R0511F

Special relay (S) S0000 to S511F -

Link register relay (Z) Z0000 to Z999F Z0000 to Z511F

Link relay (L) L0000 to L255F -

Timer (contact) (T) T0 to T999 T0 to T255

Counter (contact) (C) C0 to C511 C0 to C255

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

External input (XW) XW0 to XW511 XW0 to XW511

External output (YW) YW0 to YW511 YW0 to YW511

Internal relay (RW) RW0 to RW4095 RW0 to RW4095

Special relay (SW) SW0 to SW511 -

Link relay (LW) LW0 to LW255 -

Timer (present value) (T) T0 to T999 T0 to T255

Counter (current value) (C) C0 to C511 C0 to C255

Data register (D) D0 to D8191 D0 to D8191

Link register (W) W0 to W2047 W0 to W2047

File register (F) F0 to F32767 -

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

External input (X) X000000 to X16383F X0000 to X511F

External output (Y) Y000000 to Y16383F Y0000 to Y511F

Internal relay (R) R00000 to R8191F R0000 to R2047F

Input variable (I) I000000 to I16383F -

Output variable (Q) Q000000 to Q16383F -

Special relay (S) S00000 to S1023F S00000 to S000000FF

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

External input (XW) XW0 to XW16383 -

External output (YW) YW0 to YW16383 -

Internal relay (RW) RW0 to RW8191 -

Special relay (SW) SW0 to SW1023 SW0 to SW255

Data register (D) D0 to D8191 D0 to D8191

File register (F) F0 to F32767 F0 to F32767

Input variable (IW) IW0 to IW16383 IW0 to IW1

Output variable (QW) QW0 to QW16383 -

User global (UG) UG0 to UG262143 -
3. SIMULATION
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*1 Except the external input (XW), external output (YW), internal relay (RW), special relay (SW), input variable 
(IW), and output variable (QW)

*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(9) SHIBAURA MACHINE PLC (SHIBAURA MACHINE TCmini)

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input relay 1 (X) X0000 to X511F X0000 to X511F

Input relay 2 (I) I000 to IF7F -

Output relay 1 (Y) Y000 to YF7F Y000 to YF7F

Output relay 2 (O) O000 to OF7F -

Internal relay (R) R000 to R77F R000 to R77F

Extended internal relay 1 
(GR) GR000 to GRF7F -

Extended internal relay 2 (H) H000 to HF7F -

Extended internal relay 3 (J) J000 to JF7F -

Extended internal relay 4 (K) K000 to KF7F -

Timer (contact) (T) T000 to T77F T000 to T17F

Counter (contact) (C) C000 to C77F C000 to C17F

Shift relay (S) S000 to S07F -

Latch relay (L) L000 to L07F L000 to L07F

Edge relay (E) E000 to E77F E000 to E77F

Special aux relay (A) A000 to A16F A000 to A16F

Word device

Input register 1 (XW) XW00 to XWF7 XW00 to XWF7

Input register 2 (IW) IW00 to IWF7 -

Output register 1 (YW) YW00 to YWF7 YW00 to YWF7

Output register 2 (OW) OW00 to OWF7

Internal register (RW) RW00 to RW77 RW00 to RW77

Extended internal register 1 
(GW) GW00 to GWF7 -

Extended internal register 2 
(HW) HW00 to HWF7 -

Extended internal register 3 
(JW) JW00 to JWF7 -

Extended internal register 4 
(KW) KW00 to KWF7 -

Timer contact register (TW) TW00 to TW77 TW00 to TW17

Counter contact register 
(CW) CW00 to CW77 CW00 to CW17

Shift register (SW) SW00 to SW07 -

Latch register (LW) LW00 to LW07 LW00 to LW07

Edge register (EW) EW00 to EW77 EW00 to EW77

Special aux register (AW) AW00 to AW16 AW00 to AW16

Generic register 1 (D) D000 to DF7F D000 to DF7F

Generic register 2 (B) B000 to BF7F -

Generic register 3 (U) U000 to UF7F -

Generic register 4 (M) M000 to MF7F -

Generic register 5 (Q) Q000 to QF7F -

Timer/Counter current value 
(P) P000 to P77F P000 to P17F

Timer/Counter set value (V) V000 to V77F -
3 - 18 3. SIMULATION
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*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(10)PANASONIC PLC (Panasonic MEWNET-FP)

*1 Except for the input relay (WX), output relay (WY), internal relay (WR), special relay (WR), and link relay (WL)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input relay (X) X0000 to X511F X0000 to X511F

Output relay (Y) Y0000 to Y511F Y0000 to Y511F

Internal relay (R) R0000 to R886F R0000 to R511F

Special relay (R) R9000 to R951F R9000 to R910F

Link relay (L) L0000 to L639F L0000 to L511F

Timer contact (T) T0 to T3071 T0 to T255

Counter contact (C) C0 to C3071 C0 to C255

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

Input relay (WX) WX000 to WX511 WX000 to WX511

Output relay (WY) WY000 to WY511 WY000 to WY511

Internal relay (WR) WR000 to WR886 WR000 to WR511

Special relay (WR) WR900 to WR951 WR900 to WR910

Link relay (WL) WL000 to WL639 WL000 to WL511

Timer/counter (elapsed 
value) (EV) EV0 to EV3071 EV0 to EV255

Counter contact (set value) 
(SV) SV0 to SV3071 -

Data register (DT) DT0 to DT65532 DT0 to DT8191

Special data register (DT) DT90000 to DT90999 -

Link register (LD) LD0 to LD8447 LD0 to LD8191

File register (FL) FL0 to FL32764 -
3. SIMULATION
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(11)HITACHI IES PLC (HITACHI HIDIC H series)
Not available to GT21 and GS21.

*1 Only for timer/counter (elapsed value) (TC) and word internal output (WR)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

External input (X) X00000 to X05A95 X00000 to X05A95

External output (Y) Y00000 to Y05A95 Y00000 to Y05A95

Remote external input (X) X10000 to X49995 -

Remote external output (Y) Y10000 to Y49995 -

First CPU link (L) L0000 to L3FFF L0000 to L3FFF

Second CPU link (L1) L10000 to L13FFF -

Data area (M) M0000 to M3FFF M0000 to M3FFF

On-delay timer (TD) TD0 to TD1023 -

Single-shot timer (SS) SS0 to SS1023 -

Watchdog timer (WDT) WDT0 to WDT1023 -

Monostable timer (MS) MS0 to MS1023 -

Retentive timer (TMR) TMR0 to TMR1023 -

Up counter (CU) CU0 to CU2047 -

Ring counter (RCU) RCU0 to RCU2047 -

Up/down counter (CT) CT0 to CT2047 CT0 to CT2047

Bit internal output (R) R0 to R7BF R0 to R7BF

Leading edge detection (DIF) DIF0 to DIF511 -

Trailing edge detection 
(DFN) DFN0 to DFN511 -

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

External input (WX) WX0000 to WX05A7 -

External output (WY) WY0000 to WY05A7 -

Remote external input (WX) WX1000 to WX4997 -

Remote external output (WY) WY1000 to WY4997 -

First CPU link (WL) WL000 to WL3FF WL000 to WL3FF

Second CPU link (WL1) WL1000 to WL13FF -

Data area (WM) WM000 to WM3FF WM000 to WM1FF

Timer/counter (elapsed 
value) (TC) TC0 to TC2047 TC0 to TC2047

Word internal output (WR) WR000 to WRC3FF WR000 to WRC3FF
3 - 20 3. SIMULATION
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(12)HITACHI IES PLC (HITACHI EHV series)
Not available to GT21 and GS21.

Device name GOT monitoring available range*2 GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX Simulator2)

Bit device

External input (X) X00000 to X05A95 X00000 to X01FFF

External output (Y) Y00000 to Y05A95 Y00000 to Y01FFF

Remote external input (X) X10000 to X49A95 -

Remote external output (Y) X10000 to X49A95 -

Extended external input EX00000 to EX5A7FF -

Extended external output EY00000 to EY5A7FF -

First CPU link (L) L0000 to L3FFF L0000 to L1FFF

Second CPU link (L1) L10000 to L13FFF -

3rd CPU link (L2) L20000 to L23FFF -

4th CPU link (L3) L30000 to L33FFF -

5th CPU link (L4) L40000 to L43FFF -

6th CPU link (L5) L50000 to L53FFF -

7th CPU link (L6) L60000 to L63FFF -

8th CPU link (L7) L70000 to L73FFF -

Data area (M) M00000 to M7FFFF M00000 to M01FFF

On-delay timer (TD) TD0 to TD2559 TD0 to TD255

Off-delay timer (TDN) TDN0 to TDN2559 -

Single-shot timer (SS) SS0 to SS2559 -

Watchdog timer (WDT) WDT0 to WDT2559 -

Monostable timer (MS) MS0 to MS2559 -

Retentive timer (TMR) TMR0 to TMR2559 -

Up counter (CU) CU0 to CU511 -

Ring counter (RCU) RCU0 to RCU511 -

Up/down counter (CT) CT0 to CT511 -

Up coil up/down counter 
(CTU) CTU0 to CTU511 -

Down coil up/down counter 
(CTD) CTD0 to CTD511 -

Counter clear (CL) CL0 to CL2559 -

Bit internal output (R) R000 to R7BF -

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device
3. SIMULATION
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*1 Only for word internal output (WR) and internal output (WN)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(13)HITACHI PLC (Hitachi S10mini/S10V)
Not available to GT21 and GS21.

Word device

External input (WX) WX0000 to WX05A7 -

External output (WY) WY0000 to WY05A7 -

Remote external input (WX) WX1000 to WX49A7 -

Remote external output (WY) WY1000 to WY49A7 -

Extended external input WEX0000 to WEX5A7F -

Extended external output WEY0000 to WEY5A7F -

First CPU link (WL) WL000 to WL3FF -

Second CPU link (WL1) WL1000 to WL13FF -

3rd CPU link (WL2) WL2000 to WL23FF -

4th CPU link (WL3) WL3000 to WL33FF -

5th CPU link (WL4) WL4000 to WL43FF -

6th CPU link (WL5) WL5000 to WL53FF -

7th CPU link (WL6) WL6000 to WL63FF -

8th CPU link (WL7) WL7000 to WL73FF -

Data area (WM) WM0000 to WM7FFF -

Timer/counter (elapsed 
value) (TC) TC0 to TC2559 TC0 to TC255

Word internal output (WR) WR0000 to WREFFF WR0000 to WR8191

Internal output (WN) WN00000 to WN1FFFF -

Device name GOT monitoring available range*2 GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX Simulator2)

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

External input (X) X000 to XFFF X000 to XFFF

External output (Y) Y000 to YFFF Y000 to YFFF

Internal register (R) R000 to RFFF R000 to RFFF

Keep relay (K) K000 to KFFF K000 to KFFF

Extended internal register 
(M) M000 to MFFF -

Extended internal register 
(A) A000 to AFFF -

On-delay timer (T) T000 to T1FF T000 to T0FF

One-shot timer (U) U000 to U0FF -

Up-down counter (C) C00 to CFF C00 to CFF

Global link register (G) G000 to GFFF G000 to GFFF

Event register (E) E000 to EFFF E000 to E7FF

System register (S) S000 to SBFF S000 to S0FF

Transfer register (J) J000 to JFFF -

Receive register (Q) Q000 to QFFF -

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device
3 - 22 3. SIMULATION
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*1 Except for the external input (XW), external output (YW), internal register (RW), extended internal register (MW), extended 
internal register (AW), keep relay (KW), on-delay timer (TW), one-shot timer (UW), up-down counter (CW), global link 
register (GW), event register (EW), system register (SW), transfer register (JW), receive register (QW), long-word work 
register (LLL), floating-point work register (LF), backup single-precision floating-point work register (LG)

*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Word device

External input (XW) XW000 to XWFF0 XW000 to XWFF0

External output (YW) YW000 to YWFF0 YW000 to YWFF0

Internal register (RW) RW000 to RWFF0 RW000 to RWFF0

Extended internal register 
(MW) MW000 to MWFF0 -

Extended internal register 
(AW) AW000 to AWFF0 -

Keep relay (KW) KW000 to KWFF0 KW000 to KWFF0

On-delay timer (TW) TW000 to TW1F0 TW000 to TW0F0

One-shot timer (UW) UW000 to UW0F0 -

Up-down counter (CW) CW00 to CWF0 CW00 to CWF0

Global link register (GW) GW000 to GWFF0 GW000 to GWFF0

Event register (EW) EW000 to EWFF0 EW000 to EW7F0

System register (SW) SW000 to SWBF0 SW000 to SW0F0

Transfer register (JW) JW000 to JWFF0 -

Receive register (QW) QW000 to QWFF0 -

On-delay timer (current 
value) (TC) TC000 to TC1FF TC000 to TC0FF

On-delay timer (current 
value) (TS) TS000 to TS1FF -

One-shot timer (current 
value) (UC) UC000 to UC0FF -

One-shot timer (current 
value) (US) US000 to US0FF -

Up-down counter (current 
value) (CC) CC00 to CCFF CC00 to CCFF

Up-down counter (current 
value) (CS) CS00 to CSFF -

Function data register (DW) DW000 to DWFFF DW000 to DWFFF

Function work register (FW) FW000 to FWBFF -

Extended function work 
register (LWW) LWW0000 to LWWFFFF -

Backup work register (LXW) LXW0000 to LXW3FFF -

Long-word work register 
(LLL) LLL0000 to LLL1FFF -

Backup long-word work 
register (LML) LML0000 to LML1FFF -

Floating-point work register 
(LF) LF0000 to LF1FFF -

Backup single-precision 
floating-point work register 
(LG)

LG0000 to LG1FFF -

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)
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(14)FUJI PLC (FUJI MICREX-F series)

*1 Except for the I/O relay (WB), auxiliary relay (WM), keep relay (WK), special relay (WF), annunciator relay (WA), differential 
relay (WD), link memory (WL), data memory (BD), timer set value (0.01second) (TS), timer current value (0.01second) 
(TR), timer current value (0.1second) (W9), counter set value (CS), and counter current value (CR)

*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(15)YASKAWA PLC
(a) YASKAWA GL/PROGIC8

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

I/O relay (B) B0000 to B511F B0000 to B511F

Auxiliary relay (M) M0000 to M511F M0000 to M511F

Keep relay (K) K0000 to K063F K0000 to K063F

Special relay (F) F0000 to F125F F0000 to F015F

Annunciator relay (A) A0000 to A045F A0000 to A045F

Differential relay (D) D0000 to D036F -

Link memory (L) L0000 to L511F L0000 to L511F

Timer output (0.01second) 
(T) T000 to T511 T000 to T255

Timer output (0.1second) (T) T512 to T999 -

Counter output (C) C000 to C511 C000 to C255

Bit-specified word device*1 Monitoring available range of each word 
device Monitoring available range of each word device

Word device

I/O relay (WB) WB000 to WB511 WB000 to WB511

Auxiliary relay (WM) WM000 to WM511 WM000 to WM511

Keep relay (WK) WK000 to WK063 WK000 to WK063

Special relay (WF) WF000 to WF125 WF000 to WF015

Annunciator relay (WA) WA000 to WA045 WA000 to WA045

Differential relay (WD) WD000 to WD063 -

Link memory (WL) WL000 to WL511 WL000 to WL511

Direct access (W24) W24: 0000 to W24: 0255 -

User file (W30) User file 
(W31) : User file (W108) 
User file (W109)

W30: 0000 to W30: 4095 W31: 0000 to 
W31: 4095 W108: 0000 to W108: 4095 
W109: 0000 to W109: 4095

-

Data memory (BD) BD0 to BD4095 BD0 to BD4095

Timer set value (0.01second) 
(TS) TS0 to TS511 -

Timer current value 
(0.01second) (TR) TR0 to TR511 TR000 to TR254

Timer current value 
(0.1second) (W9) W9: 0000 to W9: 0487 -

Counter set value (CS) CS0 to CS511 -

Counter current value (CR) CR0 to CR511 CR0 to CR254

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Coil (O) O1 to O63424 O1 to O8176

Input relay (I) I1 to I63424 I1 to I8176

Link coil (D)
D1 to D2048 D1 to D2048

D10001 to D12048 D20001 to 
D22048 -

Bit-specified word device Monitoring available range of each 
word device Monitoring available range of each word device
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*1 Except for the coil (O) and input relay (I)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(b) YASKAWA CP-9200SH/MP900 series

*1 Except for the coil (MB) and input relay (IB)
*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(c) YASKAWA CP-9200(H)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Word device

Input register (Z) Z1 to Z31840 Z1 to Z8192 Z9000 to Z9256

Holding register (W)
W1 to W28291 -

SW1 to SW28291 -

Link register (R, SR)

R1 to R2048 R1 to R2048

R10001 to R12048 R20001 to 
R22048 -

SR1 to SR2048 -

SR10001 to SR12048 SR20001 to 
SR22048 -

Constant register (K) K1 to K4096 K1 to K6

Word-specified bit devices*1 Monitoring available range of each bit 
device Monitoring available range of each bit device

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Coil (MB) MB000000 to MB32767F MB000000 to MB00511F

Input relay (IB) IB0000 to IBFFFF IB0000 to IB1FFF

Bit-specified word device*1 Monitoring available range of each 
word device Monitoring available range of each word device

Word device

Input register (IW) IW0000 to IW7FFF IW0000 to IW1FFF

Holding register (MW) MW0 to MW32767 -

Coil (MB) MB0 to MB32767 MB0 to MB511

Input relay (IB) IB000 to IBFFF IB000 to IBFFF

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Coil (OB) MB000000 to MB32767F MB000000 to MB00511F

Input relay (IB) IB0000 to IBFFFF IB0000 to IB1FFF

Bit-specified word device Monitoring available range of each 
word device Monitoring available range of each word device

Word device

Input register (IW) IW00 to IW7F -

Output register (OW) OW00 to OW7F -

Data register (DW, ZD)
DW0 to DW2047 -

ZD0 to ZD2047 ZD0 to ZD6

Common register (MW) MW0 to MW7694 -

Word-specified bit devices Monitoring available range of each bit 
device Monitoring available range of each bit device

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)
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(d) YASKAWA CP-9300MS (MC compatible)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(16)YASKAWA robot controller
Not available to GT21 and GS21.

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(17)YOKOGAWA PLC
Not available to GT21 and GS21.

(a) FA500/FA-M3

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Coil (OB) OB0 to OB1023 OB0 to OB1023

Input relay (IB) IB0 to IB1023 IB0 to IB1023

Bit-specified word device Monitoring available range of each 
word device Monitoring available range of each word device

Word device

Input register (I) I0 to I63 -

Data register (M) M0 to M2047 -

Output register (O) O0 to O63 -

Word-specified bit devices Monitoring available range of each bit 
device Monitoring available range of each bit device

Device name GOT monitoring available range*1 GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX Simulator2)

Bit device IO Data (IO) IO10 to IO87207 IO0 to IO8191

Byte device Byte Variable (B) B0 to B1999 -

Word device

Integer Variable (I) I0 to I1999 I0 to I255

Resister Data (M) M0 to M999 -

Robot Control (RC) RC0 to RC8720 -

Double Int Variable (D) D0 to D1999 -

Device name GOT monitoring available range*3
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input relay (X) X00201 to X71664 X00201 to X71664

Output relay (Y) Y00201 to Y71664 Y00201 to Y71664

Internal relay (I) I1 to I65535 -

Link relay (L) L1 to L71024 L1 to L71024

Shared relay (E) E1 to E4096 -

Special relay (M) M1 to M9984 M1 to M256

Timer (TU) TU1 to TU3072 TU1 to TU256

Counter (CU) CU1 to CU3072 CU1 to CU256

Bit-specified word device*1 Monitoring available range of each 
word device Monitoring available range of each word device
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*1 Except for the timer (TP), timer (TS), counter (CP), and counter (CS)
*2 Except for the timer (TU) and counter (CU)
*3 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(18)ALLEN-BRADLEY PLC
(a) AB SLC500

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Word device

Timer (TP) TP1 to TP3072 TP1 to TP256

Timer (TS) TS1 to TS3072 -

Counter (CP) CP1 to CP3072 CP1 to CP256

Counter (CS) CS1 to CS3072 -

File register (B) B1 to B262144 -

Data register (D) D1 to D8192 D1 to D8192

Shared register (R) R1 to R4096 -

Index register (V) V1 to V256 -

Link register (W) W1 to W71024 W1 to W71024

Special register (Z) Z1 to Z512 Z1 to Z256

Word-specified bit devices*2 Monitoring available range of each bit 
device Monitoring available range of each bit device

Device name GOT monitoring available range*3
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Bit (B) B3: 0/0 to B3: 255/15 B10: 0/0 to B255: 
255/15 -

Timer (timing bit) (T) T4: 0/14 (TT) to T4: 255/14 (TT) T10: 0/
14 (TT) to T255: 255/14 (TT) -

Timer (timing bit) (T) T4: 0/13 (DN) to T4: 255/13 (DN) T10: 0/
13 (DN) to T255: 255/13 (DN) -

Counter (up counter) (C) C5: 0/15 (CU) to C5: 255/15 (CU) C10: 
0/15 (CU) to C255: 255/15 (CU) -

Counter (down counter) 
(C)

C5: 0/14 (CD) to C5: 255/14 (CD) C10: 
0/14 (CD) to C255: 255/14 (CD) -

Counter (completion bit) 
(C)

C5: 0/13 (DN) to C5: 255/13 (DN) C10: 
0/13 (DN) to C255: 255/13 (DN) -

Integer (N) N7: 0 to N7: 255 N10: 0 to N255: 255 -

Word device

Bit (B) B3: 0 to B3: 255 B10: 0 to B255: 255 -

Timer (set value) (T) T4: 0.1 (PRE) to T4: 255.1 (PRE) T10: 
0.1 (PRE) to T255: 255.1 (PRE) -

Timer (present value) (T) T4: 0.2 (ACC) to T4: 255.2 (ACC) T10: 
0.2 (ACC) to T255: 255.2 (ACC) -

Counter (set value) (C) C5: 0.1 (PRE) to C5: 255.1 (PRE) C10: 
0.1 (PRE) to C255: 255.1 (PRE) -

Counter (current value) (C) C5: 0.2 (ACC) to C5: 255.2 (ACC) C10: 
0.2 (ACC) to C255: 255.2 (ACC) -

Integer (N) N7: 0 to N7: 255 N10: 0 to N255: 255 -
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(b) AB MicroLogix

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(c) AB MicroLogix (Extended)
For the details of the communication drivers, contact our company.

(d) AB Control/CompactLogix

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(19)GE PLC (GE Series 90)
Not available to GT21 and GS21.

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Bit (B) B3: 0/0 to B255: 255/15 -

Timer (timing bit) (T) T3: 0/14 (TT) to T255: 255/14 (TT) -

Counter (completion bit) (C) T3: 0/13 (DN) to T255: 255/13 (DN) -

Counter (up counter) (C) C3: 0/15 (CU) to C255: 255/15 (CU) -

Counter (down counter) (C) C3: 0/14 (CD) to C255: 255/14 (CD) -

Counter (completion bit) (C) C3: 0/13 (DN) to C255: 255/13 (DN) -

Integer (N) N3: 0/0 to N255: 255/15 -

Word device

Bit (B)S B3: 0 to B255: 255 -

Timer (set value) (T) T3: 0.1 (PRE) to T255: 255.1 (PRE) -

Timer (present value) (T) T3: 0.2 (ACC) to T255: 255.2 (ACC) -

Counter (set value) (C) C3: 0.1 (PRE) to C255: 255.1 (PRE) -

Counter (current value) (C) C3: 0.2 (ACC) to C255: 255.2 (ACC) -

Integer (N) N3: 0 to N255: 255 -

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device BOOL BOOL0[0] to BOOL999[31999] -

Word device

INT INT0[0] to INT999[999] -

DINT DINT0[0] to DINT999[999] -

REAL REAL0[0] to REAL999[999] -

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

input(I) I00001 to I12288 I00001 to I08192

output(Q) Q00001 to Q12288 Q00001 to Q08192

internal(M) M00001 to M12288 M00001 to M08192

temporary(T) T001 to T256 -

system status(S) S001 to S128 -

system status(SA) SA001 to SA128 -

system status(SB) SB001 to SB128 -

system status(SC) SC001 to SC128 -

global data(G) G0001 to G7680 -

Word device

system register(R) R00001 to R32640 R00001 to R08192

analog input register(AI) AI0001 to AI32640 -

analog output register(AQ) AQ0001 to AQ32640 -
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(20)LS IS PLC (LS Industrial Systems XGK)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(21)LS IS PLC (LS Industrial Systems MASTER-K)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*1 GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX Simulator2)

Bit device

I/O Relay (P) P00000 to P4095F P0 to P5110

Auxiliary relay (M) M00000 to M4095F M0 to M8191

Keep Relay (K) K00000 to K4095F K0 to K8191

Link relay (L) L000000 to L11263F L0 to L8191

Special Relay (F) F00000 to F4095F -

Timer contact (T) T0000 to T8191 T0 to T255

Counter contact (C) C0000 to C4095 C0 to C255

Word device

Data Register (D) D000000 to D524287 D0 to D8191

File Register (R) R00000 to R32767 -

File Register (ZR) ZR000000 to ZR524287 -

Analog Data Register (U) U00.00 to U7F.31 -

Comm. Data Register (N) N00000 to N21503 N0 to N8191

Index Register (Z) Z000 to Z255 Z0 to Z6

Timer current value (T) T0000 to T8191 T0 to T255

Counter current value (C) C0000 to C4095 C0 to C255

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

I/O relay (P) P0000 to P063F P0000 to P063F

Auxiliary relay (M) M0000 to M191F M0000 to M191F

Keep relay (K) K0000 to K031F K0000 to K031F

Link relay (L) L0000 to L063F L0000 to L063F

Special relay (F) F0000 to F063F F0000 to F015F

Timer contact (T) T0 to T255 T0 to T255

Counter contact (C) C0 to C255 C0 to C255

Word device

I/O relay (P) P000 to P063 P000 to P063

Auxiliary relay (M) M000 to M191 M000 to M191

Keep relay (K) K000 to K031 K000 to K031

Link relay (L) L000 to L063 L000 to L063

Special relay (F) F000 to F063 F000 to F015

Timer current value (T) T0 to T255 T0 to T255

Counter current value (C) C0 to C255 C0 to C255

Step controller (S) S0 to S99 -

Data register (D) D0 to D9999 D0 to D8191
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(22)SICK safety controller (SICK Flexi Soft)

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(23)SIEMENS PLC
(a) SIEMENS S7-300/400 series

*1 Except for the input relay (IW), output relay (QW), bit memory (MW), timer (present value) (T), and counter 
(present value) (C)

*2 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input (I) I1.1 to I12.8 I1.1 to I12.8

Output (Q) Q1.1 to Q12.8 Q1.1 to Q12.8

Logic result (LQ) LQ0.0 to LQ3.7 LQ0.0 to LQ3.7

Logic input (LI) LI0.0 to LI3.7 LQ0.0 to LQ3.7

Bit-specified word device Monitoring available range of each word 
device Monitoring available range of each word device

Word device

Data (byte) (D) D0 to D99 D0 to D99

Data (word) (W) W0 to W49 W0 to W49

EFI input (byte) (EI) EI110 to EI233 EI110 to EI133

EFI output (byte) (EQ) EQ10 to EQ22 EQ10 to EQ12

Logic input (byte) (LD) LD0 to LD3 -

Logic input (word) (LW) LW0 to LW1 -

Device name GOT monitoring available range*2
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Input relay (I) I0000 to I5117 I0000 to I5117

Output relay (Q) Q0000 to Q5117 Q0000 to Q5117

Bit memory (M) M00000 to M20477 M00000 to M10237

Bit-specified word 
device*1

Monitoring available range of each word 
device Monitoring available range of each word device

Word device

Input relay (IW) IW0 to IW510 IW0 to IW510

Output relay (QW) QW0 to QW510 QW0 to QW510

Bit memory (MW) MW0 to MW2046 MW0 to MW1022

Timer (present value) (T) T0 to T511 T0 to T255

Counter (current value) 
(C) C0 to C511 C0 to C255

Data register (DB)

DB1.DBW0 to DB1.DBW65534 
DB2.DBW0 to DB2.DBW65534 : 
DB4094.DBW0 to DB4094.DBW65534 
DB4095.DBW0 to DB4095.DBW65534

-
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(b) SIEMENS S7-200 series

*1 For the precautions for using devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Device name GOT monitoring available range*1
GT Simulator3 monitoring available range 
(operable range on GX Simulator or GX 

Simulator2)

Bit device

Variable memory (V) V0 to V51197 -

Input relay (I) I00 to I77 I00 to I77

Output relay (Q) Q00 to Q77 Q00 to Q77

Bit memory (M) M000 to M317 M000 to M317

Special memory (SM) SM0000 to SM1947 -

Timer (T) T0 to T255 T0 to T255

Counter (C) C0 to C255 C0 to C255

Sequence control relay (S) S000 to S317 -

Word device

Variable memory (VW) VW0 to VW5118 VW0 to VW1022

Input relay (IW) IW0 to IW6 IW0 to IW6

Output relay (QW) QW0 to QW6 QW0 to QW6

Analog input (AIW) AIW0 to AIW30 -

Analog output (AQW) AQW0 to AQW30 -

Bit memory (MW) MW0 to MW30 MW0 to MW30

Special memory (SMW) SMW0 to SMW192 -

Timer (T) T0 to T255 T0 to T255

Counter (C) C0 to C255 C0 to C255

High speed counter (HC) HC0 to HC2 -

Sequence control relay (SW) SW0 to SW30 -
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■2 Connecting with Mitsubishi Electric products

GT Simulator3 can monitor the devices that are monitored by the GOT.
For the devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller
For the following controllers, some of their devices cannot be monitored through a motion controller, simple motion 
module, or PLC.
• MR-J4-GF(-RJ)

• Inverter

For the PLC CPUs that can be monitored by GT Simulator3, refer to the following.
➟3.1.2 Monitoring-supported Controllers

■3 Connecting with non-Mitsubishi Electric products

GT Simulator3 can monitor the devices that are monitored by the GOT.
For the devices that can be monitored with the GOT, refer to the following.

➟12.4 Device Range and Settings of Each Controller
For the non-Mitsubishi Electric equipment that can be monitored with GT Simulator3, refer to the following.

➟■3 Non-Mitsubishi Electric products

Controller to be routed Monitoring target Devices that cannot be monitored

Motion controller
Simple motion module

MR-J4-GF(-RJ)

PF49 to PF64, PF1049 to PF1064
PC65 to PC80, PC1065 to PC1080
MD11 to MD18
PT1 to PT80, PT1001 to PT1080
PN1 to PN32, PN1001 to PN1032
POS1 to POS255, POS1001 to POS1255
SPD1 to SP255, SPD1001 to SP1255
ACT1 to ACT255, ACT1001 to ACT1255
DCT1 to DCT255, DCT1001 to DCT1255
DWL1 to DWL255, DWL1001 to DWL1255
AUX1 to AUX255, AUX1001 to AUX1255

Controller to be routed Monitoring target Devices that cannot be monitored

PLC Inverter

IOST0 to IOST127
CMD0 to CMD47
AL0 to AL899
LPr0 to LPr1500
OP0 to OP4
PV1 to PV143

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.1.4 Simulation-supported/unsupported functions

The following shows the functions that are compatible and incompatible with simulation by GT Simulator3 Version1.

■1 GT27
(1) Common function

○: Supported, -: Unsupported

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System font display ○ Multi-channel connection -

Option font display ○ Vertical display ○

Superimposition of objects ○ Touch panel and touch key ○

Base screen display ○ Numerical display/input ○

Overlap window display ○ Text display/input ○

Superimpose window display ○ Historical data list display ○

Key window display ○ Clock display ○

Set overlay screen ○ Comment display ○

Screen Switching ○ Alarm display ○

Station No. Switching ○ Alarm popup display ○

Buffer Memory Unit No. Switching ○ Recipe display (record list) ○

Language Switching ○ Graphical meter ○

System information ○ Panelmeter ○

Security authentication ○ Historical trend graph ○

Status observation ○ Line graph ○

Time action ○ Bar graph ○

Hard copy function ○ Scatter graph ○

Comment ○ Statistics graph ○

Figure ○ Level display ○

Internal device ○ Touch switch ○

Cursor movement ○ Slider ○

Operation Log ○ Video/RGB display object -

Logging ○ Script parts ○

Recipe ○ Mobile screen display -

Script ○ Hyperlink -
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(2) Utility function

○: Supported, -: Unsupported

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

[GOT basic set]

[Display] ○ [Time] -

[Language] ○ [Controller] -

[Specific Information] - [Ethernet Communication] -

[IP Address] - [Transparent Mode] -

[IP filter setting] - [GOT Internal Device Monitor] -

[Operation] ○ [Security] ○

[Utility Call Key] ○ [Operator Authentication] ○

[USB Host] -

[Ext. func. Set]

[SoftGOT-GOT Link Function] - [Wireless LAN Setting] -

[VNC Server Function] - [System launcher] -

[Sequence Program Monitor] - [iQSS utility] -

[Backup Restoration] - [ANDON Setting] -

[License Management] - [Ethernet printer] -

[Video/RGB] - [Network Drive] -

[Multimedia] -

[Maintenance]

[Batch Self Check] - [Font check] -

[USB Device Management] - [Touch panel check] -

[Clean/Display Screen] - [I/O check] -

[Touch panel calibration] - [Ethernet Status Check] -

[System Alarm] ○ [GOT Information] -

[Drawing check] - [GOT Mobile information] -

[Monitor]

[System launcher] - [Q Motion SFC monitor] -

[Device monitor] - [Log viewer] -

[Seq. program monitor(Ladder)] - [Network status display] -

[Seq. program mon.(iQ-R/iQ-L Ladder)] - [FX list editor] -

[Seq. program mon.(iQ-F Ladder)] - [CNC Machining Program Edit] -

[FX Ladder monitor] - [CNC data I/O] -

[Network monitor] - [Motion program editor] -

[Intelligent module monitor] - [Motion program I/O] -

[Servo amp Monitor] - [MELSEC-L Troubleshooting] -

[Q Motion monitor] - [iQSS utility] -

[R Motion monitor] - [Drive recorder] -

[CNC monitor] - [CC-Link IE diagnostics] -

[CNC monitor2] - [Servo amplifier graph] -

[Seq. program monitor(SFC)] - [Vision sensor monitor] -

[R Motion SFC monitor] -

[Data mng.]

[Alarm information] ○ [Package Management] ○ *1

[Image File Management] ○ [Backup Restoration] -

[Recipe Information] ○ [SRAM control] ○ *2

[Logging information] ○ [Memory card format] -

[Operation log information] ○ [Memory check] -

[File manager] - [GOT Pkg. acquisition] -

[File print] ○ *3
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*1 [Delete all labels] and [Sort out labels] are supported.
*2 [Initialize all] and [Initialize selected area] are supported.
*3 Only [Preview] is supported.

(3) Extended function

○: Supported, -: Unsupported

*1 Only [Preview] is supported.
*2 In the simulation, files can be saved into virtual drives only.

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Screen gesture - MES Interface -

Object gesture - Device monitor -

Kana-Kanji/Pinyin conversion ○ Network monitor -

Wireless LAN - Log viewer -

SoftGOT-GOT Link Function - iQSS Utility -

System Launcher - Intelligent module monitor -

Sequence Program Monitor(Ladder) - Servo amplifier monitor -

Sequence Program Monitor (iQ-R/iQ-L Ladder) - Drive Recorder -

Sequence Program Monitor (iQ-F Ladder) - R motion monitor -

Sequence Program Monitor(SFC) - Q motion monitor -

FX Ladder Monitor - CNC Monitor -

Backup/restore - CNC Data I/O -

Gateway(Server, Client) - CNC Manufacturing Program Editor -

Gateway(Mail) - CNC Monitor 2 -

Gateway(FTP Server) - Motion Program Editor -

File Transfer - Motion Program Input/Output -

Barcode - R Motion SFC Monitor -

RFID - Q Motion SFC Monitor -

Remote personal computer operation (Serial) - FX list editor -

Remote personal computer operation (Ethernet) - Vision sensor monitor -

VNC server - CC-Link IE TSN/CC-Link IE Field Network 
diagnostics -

Video display - Recipe Operation ○

RGB display - Recipe Display (Record List) ○

Multimedia - Operation log screen image -

Operation panel - Operator authentication ○

External I/O - File Manager -

Report ○ File print ○ *1

Printer - Document Display ○

Sound Output ○ MELSEC-L Troubleshooting Function -

GOT Network Interaction - Video/RGB display object -

GOT Mobile Setting - GOT Platform Library -

Device Data Transfer ○ Network Drive ○ *2

Servo amplifier graph - Base screen size expansion ○
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■2 GT25 and GS25
(1) Common function

○: Supported, -: Unsupported

*1 In simulation of GT2505-V, the utility screen is displayed in inversed orientation as compared with the utility screen 
displayed on the physical GT2505-V.

(2) Utility function

○: Supported, -: Unsupported

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System font display ○ Multi-channel connection -

Option font display ○ Vertical display ○ *1

Superimposition of objects ○ Touch panel and touch key ○

Base screen display ○ Numerical display/input ○

Overlap window display ○ Text display/input ○

Superimpose window display ○ Historical data list display ○

Key window display ○ Clock display ○

Set overlay screen ○ Comment display ○

Screen Switching ○ Alarm display ○

Station No. Switching ○ Alarm popup display ○

Buffer Memory Unit No. Switching ○ Recipe display (record list) ○

Language Switching ○ Graphical meter ○

System information ○ Panelmeter ○

Security authentication ○ Historical trend graph ○

Status observation ○ Line graph ○

Time action ○ Bar graph ○

Hard copy function ○ Scatter graph ○

Comment ○ Statistics graph ○

Figure ○ Level display ○

Internal device ○ Touch switch ○

Cursor movement ○ Slider ○

Operation Log ○ Script parts ○

Logging ○ Mobile screen display -

Recipe ○ Hyperlink -

Script ○

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

[GOT basic set]

[Display] ○ [Time] -

[Language] ○ [Controller] -

[Specific Information] - [Ethernet Communication] -

[IP Address] - [Transparent Mode] -

[IP filter setting] - [GOT Internal Device Monitor] -

[Operation] ○ [Security] ○

[Utility Call Key] ○ [Operator Authentication] ○

[USB Host] -
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*1 [Delete all labels] and [Sort out labels] are supported.
*2 [Initialize all] and [Initialize selected area] are supported.
*3 Only [Preview] is supported.

[Ext. func. Set]

[SoftGOT-GOT Link Function] - [Wireless LAN Setting] -

[VNC Server Function] - [System launcher] -

[Sequence Program Monitor] - [iQSS utility] -

[Backup Restoration] - [ANDON Setting] -

[License Management] - [Ethernet printer] -

[Video/RGB] - [Network Drive] -

[Multimedia] -

[Maintenance]

[Batch Self Check] - [Font check] -

[USB Device Management] - [Touch panel check] -

[Clean/Display Screen] - [I/O check] -

[Touch panel calibration] - [Ethernet Status Check] -

[System Alarm] ○ [GOT Information] -

[Drawing check] - [GOT Mobile information] -

[Monitor]

[System launcher] - [Q Motion SFC monitor] -

[Device monitor] - [Log viewer] -

[Seq. program monitor(Ladder)] - [Network status display] -

[Seq. program mon.(iQ-R/iQ-L Ladder)] - [FX list editor] -

[Seq. program mon.(iQ-F Ladder)] - [CNC Machining Program Edit] -

[FX Ladder monitor] - [CNC data I/O] -

[Network monitor] - [Motion program editor] -

[Intelligent module monitor] - [Motion program I/O] -

[Servo amp Monitor] - [MELSEC-L Troubleshooting] -

[Q Motion monitor] - [iQSS utility] -

[R Motion monitor] - [Drive recorder] -

[CNC monitor] - [CC-Link IE diagnostics] -

[CNC monitor2] - [Servo amplifier graph] -

[Seq. program monitor(SFC)] - [Vision sensor monitor] -

[R Motion SFC monitor] -

[Data mng.]

[Alarm information] ○ [Package Management] ○ *1

[Image File Management] ○ [Backup Restoration] -

[Recipe Information] ○ [SRAM control] ○ *2

[Logging information] ○ [Memory card format] -

[Operation log information] ○ [Memory check] -

[File manager] - [GOT Pkg. acquisition] -

[File print] ○ *3

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed
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(3) Extended function

○: Supported, -: Unsupported

*1 Not available to GT2505-V and GT25HS-V.
*2 Only [Preview] is supported.
*3 In the simulation, files can be saved into virtual drives only.

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Kana-Kanji/Pinyin conversion ○ Network monitor -

Wireless LAN - Log viewer -

SoftGOT-GOT Link Function - iQSS Utility -

System Launcher - Intelligent module monitor -

Sequence Program Monitor(Ladder) - Servo amplifier monitor -

Sequence Program Monitor (iQ-R/iQ-L Ladder) - Drive Recorder -

Sequence Program Monitor (iQ-F Ladder) - Servo amplifier graph -

Sequence Program Monitor(SFC) - R motion monitor -

FX Ladder Monitor - Q motion monitor -

Backup/restore - CNC Monitor -

Gateway(Server, Client) - CNC Data I/O -

Gateway(Mail) - CNC Manufacturing Program Editor -

Gateway(FTP Server) - CNC Monitor 2 -

File Transfer - Motion Program Editor -

Barcode - Motion Program Input/Output -

RFID - R Motion SFC Monitor -

Remote personal computer operation (Serial) - Q Motion SFC Monitor -

Remote personal computer operation (Ethernet) - FX list editor -

VNC server - CC-Link IE TSN/CC-Link IE Field Network 
diagnostics -

Video display - Vision sensor monitor -

RGB display - Recipe Operation ○

Multimedia - Recipe Display (Record List) ○

Operation panel - Operation log screen image -

Report ○ Operator authentication ○

External I/O - File Manager -

Printer - File print ○ *2

Sound Output ○ *1 Document Display ○

GOT Network Interaction - MELSEC-L Troubleshooting Function -

GOT Mobile Setting - GOT Platform Library -

Device Data Transfer ○ Network Drive ○ *3

MES Interface - Base screen size expansion ○

Device monitor -
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■3 GT23
(1) Common function

○: Supported, -: Unsupported

(2) Utility function

○: Supported, -: Unsupported

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System font display ○ Script ○

Option font display ○ Multi-channel connection -

Superimposition of objects ○ Vertical display ○

Base screen display ○ Touch panel and touch key ○

Overlap window display ○ Numerical display/input ○

Superimpose window display ○ Text display/input ○

Key window display ○ Historical data list display ○

Set overlay screen ○ Clock display ○

Screen Switching ○ Comment display ○

Station No. Switching ○ Alarm display ○

Buffer Memory Unit No. Switching ○ Alarm popup display ○

Language Switching ○ Recipe display (record list) ○

System information ○ Graphical meter ○

Security authentication ○ Panelmeter ○

Status observation ○ Historical trend graph ○

Time action ○ Line graph ○

Hard copy function ○ Bar graph ○

Comment ○ Scatter graph ○

Figure ○ Statistics graph ○

Internal device ○ Level display ○

Cursor movement ○ Touch switch ○

Operation Log ○ Slider ○

Logging ○ Script parts ○

Recipe ○

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

[GOT basic set]

[Display] ○ [Time] -

[Language] ○ [Controller] -

[Specific Information] - [Ethernet Communication] -

[IP Address] - [Transparent Mode] -

[IP filter setting] - [GOT Internal Device Monitor] -

[Operation] ○ [Security] ○

[Utility Call Key] ○ [Operator Authentication] ○

[USB Host] -

[Ext. func. Set]
[Backup Restoration] - [Ethernet printer] -

[System launcher] -
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*1 [Delete all labels] and [Sort out labels] are supported.
*2 [Initialize all] and [Initialize selected area] are supported.
*3 Only [Preview] is supported.

(3) Extended function

○: Supported, -: Unsupported

*1 Only [Preview] is supported.

■4 GT21 and GS21
(1) Common function

○: Supported, -: Unsupported

[Maintenance]

[Batch Self Check] - [Font check] -

[USB Device Management] - [Touch panel check] -

[Clean/Display Screen] - [I/O check] -

[Touch panel calibration] - [Ethernet Status Check] -

[System Alarm] ○ [GOT Information] -

[Drawing check] -

[Monitor] [System launcher] - [Device monitor] -

[Data mng.]

[Alarm information] ○ [Package Management] ○ *1

[Image File Management] ○ [Backup Restoration] -

[Recipe Information] ○ [SRAM control] ○ *2

[Logging information] ○ [Memory card format] -

[Operation log information] ○ [Memory check] -

[File manager] - [GOT data pkg. acquisition] -

[File print] ○ *3

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System Launcher - Device monitor -

Backup/restore - FX list editor -

Gateway(FTP Server) - Recipe Operation ○

File Transfer - Recipe Display (Record List) ○

Barcode - Operation log screen image -

RFID - Operator authentication -

Report ○ File Manager -

Printer - File print ○ *1

GOT Network Interaction - GOT Platform Library -

Device Data Transfer ○

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System font display ○ Numerical display/input ○

Option font display ○ Text display/input ○

Superimposition of objects ○ Historical data list display ○

Base screen display ○ Clock display ○

Overlap window display ○ Comment display ○

Superimpose window display ○ Alarm display ○

Key window display ○ Alarm popup display ○
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*1 [Shift to GOT offline mode] is not supported.

(2) Utility function

○: Supported, -: Unsupported

Set overlay screen ○ Panelmeter ○

Screen Switching ○ Historical trend graph ○

Station No. Switching ○ Line graph ○

Buffer Memory Unit No. Switching ○ Bar graph ○

Language Switching ○ Scatter graph ○

System information ○ Statistics graph ○

Security authentication ○ Level display ○

Status observation ○ Touch switch ○

Time action ○ Slider ○

Hard copy function ○ Script parts ○

Comment ○ Gateway(FTP Server) -

Figure ○ File Transfer -

Internal device ○ Backup/restore -

Cursor movement ○ Barcode -

Operation Log ○*1 RFID -

Script ○ Report ○

Recipe ○ Printer -

Multi-channel connection - Device Data Transfer ○

Vertical display ○ Operator authentication ○

Touch panel and touch key ○

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

[Language] - ○

[Comm. Setting]

[Standard I/F] - [Ethernet check] -

[GOT IP Address] - [Transparent mode] -

[Comm. Monitor] - [Keyword] -

[IP filter setting]

[GOT setup]
[Display] ○ [Unique info] -

[Operation] ○ [GOT Internal Device Monitor] -

[Security setting]
[Security level] ○ [Login/Logout] ○

[Operator] ○

[Time setting] [Time setting] -

[Data]

[OS information] - [SD card access] -

[Alarm info.] - [Memory card format] -

[Recipe info.] - [Clear data] -

[Logging info.] - [Backup/Restore Function] -

[Debug]
[Device monitor] - [FX3U-ENET-ADP] -

[FX list editor] -

[Maintenance]
[Calibration] - [Panel check] -

[Clean] -
3. SIMULATION
3.1 Specifications

3 - 41



3.1.5 Destination to save data

GT Simulator3 uses the folders on the hard drive of the personal computer as virtual drives.

■1 For functions saving data into a data storage or file server
When a data storage or file server is specified to save the files for functions including object functions and extended 
functions, data is saved onto the hard drive of the personal computer.
The files for each function are saved into the folders as shown below.

The drive unavailable to the simulation target GOT is not usable.
*1 For the working folder, refer to the following.

➟■3 Working folder
*2 In the simulation, files can be saved into virtual drives only.
*3 For details on drive V, refer to the following.

➟3.3.1 ■12 Virtual drive V

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

(Working folder)

GT2    00

Drive

A

Folder name set in GT Designer3

G2GssUsr

Regardless of the folder name or file name set in GT Designer3, 
the file shown on the left is stored in the [G2GssUsr] folder.

Folder storing files for each function

Print image of the hard copy
   HARDCOPY.BMP

B, E, F, G

A folder is created for each drive.

A folder corresponding to the selected GOT is created.

Folder name set in GT Designer3 Folder storing files for each function

Standard SD card

USB drive

*1

Print image of the report
   REP*****.CSV
   [*****] indicates the screen number.

N

Folder name set in GT Designer3 Folder storing files for each function *²

Built-in RAM *³

Network drive

V
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■2 For functions requiring the user to save data into a data storage
When registering BMP files or JPEG files used as parts or data for document display, save them in the hard disk of the 
personal computer.
Store each data in the following (user-created) folders.
(The drive to be used depends on the specifications of the object or setting.)

*1 For the working folder, refer to the following.

➟■3 Working folder
*2 You can change the file name.

For how to use BMP files or JPEG files, refer to the following.
➟5.9.3 How to use parts ([Parts])

■3 Working folder
The following shows a working folder.
Users\(user name)\AppData\Local\MITSUBISHI\GSS3

Drive

A

PDFDAT
Docimg

(Working folder)

B

GT2    00 A folder corresponding to the selected GOT is created.

*1

Image *2

Stores the JPEG files for the document display.

Stores BMP or JPEG files.
Stores the PDF files for the document display.
3. SIMULATION
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3.2 Connecting

➟3.2.1 Connecting with the controller simulators
3.2.2 Connecting with Mitsubishi Electric products
3.2.3 Connecting with non-Mitsubishi Electric products

3.2.1 Connecting with the controller simulators

Install a controller simulator to be connected.

■1 When connecting with GX Simulator
• GX Developer
• GX Simulator

For how to install GX Developer or GX Simulator, refer to the following.
➟GX Developer Version□ Operating Manual (Startup)

■2 When connecting with GX Simulator2
• GX Works2

For how to install GX Works2, refer to the following.
➟GX Works2 Installation Procedure Manual

■3 When connecting with GX Simulator3
• GX Works3

For how to install GX Works3, refer to the following.
➟GX Works3 Installation Instructions

■4 When connecting with MT Simulator2
• MT Developer2

For how to install MT Developer2, refer to the following.
➟MELSOFT MT Works2 Installation Instructions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Works3 Version

Personal computer

Printer cable Windows-compatible printer
Controller simulator

(Required for using the printer function)
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3.2.2 Connecting with Mitsubishi Electric products

➟■1 Connecting with RCPU or MELSEC iQ-R series Motion CPU
■2 Connecting with LHCPU
■3 Connecting with QCPU or Q series Motion CPU
■4 Connecting with LCPU
■5 Connecting with QnACPU, ACPU, Motion CPU (A series), or FXCPU
■6 Connecting with MELSEC iQ-F
■7 Connecting with the MELSECNET/H remote I/O station
■8 Connecting with CC-Link IE Field Network head unit
■9 Connecting with MELDAS C6/C64

■1 Connecting with RCPU or MELSEC iQ-R series Motion CPU

*1 For how to install GX Works3, refer to the following.

➟GX Works3 Installation Instructions
*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 Monitoring-supported Controllers

(1) Access range
The following shows the access range for the direct CPU connection (USB) in the following configuration.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer
GX Works3 *1

Windows-compatible printer

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2
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(a) Single network

○: Accessible, -: Inaccessible

*1 The routing parameter cannot be set for a QSCPU, and therefore the GOT cannot access the networks on which 
the CPU is not located.

*2 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE 
Field Network.

(b) Multiple networks

○: Accessible, -: Inaccessible

*1 The routing parameter cannot be set for a QSCPU, and therefore the GOT cannot access the networks on which 
the CPU is not located.

*2 Only the universal model is applicable.
*3 This network is inaccessible when an RCPU or LCPU is used in relay station No. 1.
*4 This network is inaccessible when an LCPU is used in relay station No. 1.
*5 This network is inaccessible when an FX5CPU is used in relay station No. 1.

Connected 
station Relay station

RCPU Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU*1 QCPU (A mode) QnACPU ACPU FX5CPU

○

Mnet/10(H) - - - - - - - - -

Ethernet ○ - ○ ○ ○ - - - -

CC IE Cont ○ - - ○ ○ - - - -

CC IE Field ○ - ○ ○ ○ - - - ○*2

Connected 
station Relay station

RCPU Relay 
network 1

Relay 
network 2

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU*1 QCPU (A 
mode) QnACPU ACPU FX5CPU

○ Mnet/10(H)

Mnet/10(H) - - - - - - - - -

Ethernet - - - - - - - - -

CC IE Cont - - - - - - - - -

CC IE Field - - - - - - - - -

○ Ethernet

Mnet/10(H)*3 - - - ○ ○ - - - -

Ethernet ○ - ○ ○ ○ - - - -

CC IE Cont*4 ○ - - ○ ○ - - - -

CC IE Field ○ - ○ ○*2 ○ - - - -

○ CC IE Cont

Mnet/10(H)*3 - - - ○ ○ - - - -

Ethernet ○ - ○ ○ ○ - - - -

CC IE Cont*4 ○ - - ○ ○ - - - -

CC IE Field ○ - ○ ○*2 ○ - - - -

○ CC IE Field*1

Mnet/
10(H)*3*5 - - - ○ ○ - - - -

Ethernet*5 ○ - ○ ○ ○ - - - -

CC IE 
Cont*4*5 ○ - - ○ ○ - - - -

CC IE Field*5 ○ - ○ ○*2 ○ - - - -
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(2) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

(b) When using a USB cable manufactured by BUFFALO KOKUYO SUPPLY INC.

(c) When using a USB cable manufactured by SANWA SUPPLY INC.

■2 Connecting with LHCPU

*1 For how to install GX Works3, refer to the following.

➟GX Works3 Installation Instructions
*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 Monitoring-supported Controllers

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable/USB conversion adapter

AU2-30 (3 m) + AUXUBM5

USB cable/USB conversion adapter

KU-AMB530 (3 m) or KU-AMB550 (5 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

+

Personal computer side: USB TYPE-A Controller side: USB Mini-B

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer
GX Works3 *1

Windows-compatible printer
3. SIMULATION
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(1) Access range
The following shows the access range for the direct CPU connection (USB) in the following configuration.

(a) Single network
For the direct CPU connection (USB), the CPUs on relay network 1 are inaccessible.

(b) Multiple networks
For the direct CPU connection (USB), the CPUs on relay network 1 and relay network 2 are inaccessible.

(2) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

(b) When using a USB cable manufactured by SANWA SUPPLY INC.

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable/USB conversion adapter

KU-AMB530 (3 m) or KU-AMB550 (5 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B
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■3 Connecting with QCPU or Q series Motion CPU

*1 For how to install GX Developer or GX Works2, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
GX Works2 Installation Procedure Manual

*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 Monitoring-supported Controllers

(1) Access range
The following shows the access range for the direct CPU connection (serial) in the following configuration.

(a) Single network

○: Accessible, -: Inaccessible, ▲: Accessible when the connected CPU is the control station

*1 Only the universal model is applicable.
*2 MELDAS C6* is not applicable.
*3 When QSCPU is connected by USB, access to other stations or other PLCs is unavailable.
*4 Depending on the CPU type, the access range is different.

Refer to the following table.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Developer *1

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer

GX Works2 *1 Windows-compatible printer

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2

Connected 
station Relay station

QCPU, 
QSCPU*3

Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A mode) QnACPU*2 ACPU*4 FX5CPU

○

Mnet/10(H) - - - ○ ○ ○ ○ ○ -

Ethernet - - ○ ○ ○ - ○ - -

CC IE Cont - - - ○ ○ - - - -

CC IE 
Field*1 - - ○ ○*1 ○ - - - -

Connected station
Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU

QnCPU ▲ ○ - ○
3. SIMULATION
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(b) Multiple networks

○: Accessible, -: Inaccessible, ▲: Accessible when the connected CPU is the control station

*1 Only the universal model is applicable.
*2 MELDAS C6* is not applicable.
*3 When QSCPU is connected by USB, access to other stations or other PLCs is unavailable.
*4 Depending on the CPU type, the access range is different.

Refer to the following table.

(2) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using an RS-232 cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

*1 Only the PLC CPU area (CPU No. 1) of Q170MCPU, Q170MSCPU, and Q170MSCPU-S1 (Q series Motion 
CPU) can be connected.

(b) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

Connected 
station Relay station

QCPU, 
QSCPU*3

Relay 
network 1

Relay 
network 2

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU
*2 ACPU*4 FX5CPU

○ Mnet/10(H)

Mnet/10(H) - - - ○ ○ ○ ○ ○ -

Ethernet - - ○ ○ ○ - ○ - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○ ○ - - - -

○ Ethernet

Mnet/10(H) - - - ○ ○ - ○ - -

Ethernet - - ○ ○ ○ - ○ - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○ ○ - - - -

○ CC IE Cont

Mnet/10(H) - - - ○ ○ - - - -

Ethernet - - ○ ○ ○ - - - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○ ○ - - - -

○ CC IE Field*1

Mnet/10(H) - - - ○ ○ - - - -

Ethernet - - ○ ○ ○ - - - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○*1 ○ - - - -

Connected station
Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU

QnCPU ▲ ○ - ○

RS-232 cable*1

GT01-C30R2-6P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

Personal computer side: 9-pin D-sub connector Controller side: MINI-DIN6-pin
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• When using a Universal model QCPU

(c) When using a USB cable manufactured by ELECOM CO., LTD.
• When using a Universal model QCPU

• When using a Basic model QCPU, High Performance model QCPU, Process CPU, or Redundant CPU

(d) When using a USB cable manufactured by BUFFALO KOKUYO SUPPLY INC.
• When using a Universal model QCPU

• When using a Basic model QCPU, High Performance model QCPU, Process CPU, or Redundant CPU

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable/USB conversion adapter

USB-M53 (3 m)

USB2-30 (3 m) + AD-USBBFTM5M

USB cable

USB2-30 (3 m)

USB cable/USB conversion adapter

AU2-30 (3 m) + AUXUBM5

USB cable

USB2-30 (3 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

+

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

+

Personal computer side: USB TYPE-A Controller side: USB Mini-B
3. SIMULATION
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(e) When using a LOAS USB cable
• When using a Universal model QCPU

■4 Connecting with LCPU

*1 For how to install GX Developer, GX Simulator, or GX Simulator2, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
GX Works2 Installation Procedure Manual

*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 ■2 Mitsubishi Electric products

(1) Access range
The following shows the access range for the direct CPU connection (serial) in the following configuration.

(a) Single network

○: Accessible, -: Inaccessible

*1 Only the universal model is applicable.

USB cable

ZUM-430 (3 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Developer *1

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer

GX Works2 *1 Windows-compatible printer

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2

Connected 
station Relay station

LCPU Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A mode) QnACPU ACPU FX5CPU

○ Ethernet - - ○ ○ ○ - - - -

○ CC IE Field - - ○ ○*1 ○ - - - -
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(b) Multiple networks

○: Accessible, -: Inaccessible

*1 Only the universal model is applicable.

(2) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using an RS-232 cable manufactured by Mitsubishi Electric System & Service Co., Ltd.

*1 The adapter L6ADP-R2 (manufactured by Mitsubishi Electric Corporation) is required for the direct CPU 
connection.

(b) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

• When using a Universal model QCPU

(c) When using a USB cable manufactured by ELECOM CO., LTD.

Connected 
station Relay station

LCPU Relay 
network 1

Relay 
network 2

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode) QnACPU ACPU FX5CPU

○ Ethernet

Mnet/10(H) - - - ○ ○ - - - -

Ethernet - - ○ ○ ○ - - - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○*1 - - - - -

○ CC IE Field*1

Mnet/10(H) - - - ○ ○ - - - -

Ethernet - - ○ ○ ○ - - - -

CC IE Cont - - - ○ ○ - - - -

CC IE Field - - ○ ○*1 - - - - -

RS-232 cable*1

GT01-C30R2-6P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable

USB-M53 (3 m)

Personal computer side: 9-pin D-sub connector Controller side: MINI-DIN6-pin

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B
3. SIMULATION
3.2 Connecting

3 - 53



(d) When using a LOAS USB cable

■5 Connecting with QnACPU, ACPU, Motion CPU (A series), or FXCPU

*1 For how to install GX Developer, GX Simulator, or GX Simulator2, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
GX Works2 Installation Procedure Manual

*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 ■2 Mitsubishi Electric products

(1) Access range
The following shows the access range for the direct CPU connection (serial) in the following configuration.

(a) Single network (connection with QnACPU)

○: Accessible, -: Inaccessible

*1 Only the link relay device or link register device assigned by the link parameter can be monitored.
Depending on the type of the connected station, the access range is different.

USB cable

ZUM-430 (3 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Developer *1

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer

GX Works2 *1 Windows-compatible printer

Connected 
station Relay station

QnACPU, 
MELDAS C6*

Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU, 
MELDAS 

C6*
ACPU FX5CPU

○

Mnet/10(H) - - - - - - ○ - -

Mnet(II)*1*2 - - - - - - ○*2 - -

Ethernet - - - - - - ○ - -

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2
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• Master station: Local stations can be monitored.
• Local station: Only the master station can be monitored.
• Master station on the third hierarchy: The master station on the second hierarchy and local stations on the third 

hierarchy can be monitored.
*2 MELDAS C6* is inaccessible.

(b) Multiple networks (connection with QnACPU)

○: Accessible, -: Inaccessible

*1 Only the link relay device or link register device assigned by the link parameter can be monitored.
Depending on the type of the connected station, the access range is different.
• Master station: Local stations can be monitored.
• Local station: Only the master station can be monitored.
• Master station on the third hierarchy: The master station on the second hierarchy and local stations on the third 

hierarchy can be monitored.
*2 MELDAS C6* is inaccessible.

(c) Single network (connection with ACPU or Motion CPU (A series))

○: Accessible, -: Inaccessible, ▲: Accessible when the connected CPU is the control station, : Accessible when the 
access destination CPU is the control station

*1 Depending on the CPU type, the access range is different.
Refer to the following table.

*2 Only the link relay device or link register device assigned by the link parameter can be monitored.
Depending on the type of the connected station, the access range is different.
• Master station: Local stations can be monitored.
• Local station: Only the master station can be monitored.
• Master station on the third hierarchy: The master station on the second hierarchy and local stations on the third 

hierarchy can be monitored.
*3 MELDAS C6* is inaccessible.

Connected 
station Relay station

QnACPU, 
MELDAS C6*

Relay 
network 1

Relay 
network 2

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU, 
MELDAS 

C6*
ACPU FX5CPU

○ Mnet/10(H)
Mnet/10(H) - - - - - - ○ - -

Ethernet - - - - - - ○ - -

○ Ethernet
Mnet/10(H) - - - - - - ○ - -

Ethernet - - - - - - ○ - -

Connected 
station Relay station

ACPU, QCPU 
(A mode)

Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU, 
MELDAS 

C6*
ACPU FX5CPU

○
Mnet/
10(H)*1 - - - - - ○ - ○ -

Mnet(II)*2 - - - - - ○ ○*3 ○ -

Connected station
Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU

AnA(AnN)CPU - - -

AnUCPU ▲ ○ - ○
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(d) Multiple networks (connection with ACPU or Motion CPU (A series))

○: Accessible, -: Inaccessible, ▲: Accessible when the connected CPU is the control station, : Accessible when the 
access destination CPU is the control station

*1 Depending on the CPU type, the access range is different.
Refer to the following table.

*2 Only the link relay device or link register device assigned by the link parameter can be monitored.
Depending on the type of the connected station, the access range is different.
• Master station: Local stations can be monitored.
• Local station: Only the master station can be monitored.
• Master station on the third hierarchy: The master station on the second hierarchy and local stations on the third 

hierarchy can be monitored.
*3 MELDAS C6* is inaccessible.

(e) Single network (connection with FXCPU)
For the direct CPU connection (serial), the CPUs on relay network 1 are inaccessible.

(f) Multiple networks (connection with FXCPU)
For the direct CPU connection (serial), the CPUs on relay network 1 and relay network 2 are inaccessible.

Connected 
station Relay station

ACPU, QCPU 
(A mode)

Relay 
network 1

Relay 
network 2

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU, 
MELDAS 

C6*
ACPU FX5CPU

○ Mnet/10(H) Mnet/10(H) - - - - - ○ - ○ -

Connected station
Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU

AnA(AnN)CPU - - -

AnUCPU ▲ ○ - ○
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(2) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using an RS-232 cable or RS-422 cable manufactured by Mitsubishi Electric Corporation

*1 When using this cable for a DOS/V personal computer, a straight cable for conversion between 9-pin D-sub and 
25-pin D-sub is required separately.

*2 To check whether the cable is compatible with QnACPU or ACPU or not, check the model name label on the 
cable. (The incompatible product cannot be used.)

*3 When FX3UC or FX3UCPU is connected to FX-232AWC-H, the transmission speeds of 9600, 19200, 38400, 
57600, and 115200 bps are available.

When FX-232AWC or FX-232AW is connected, the transmission speeds of 9600 and 19200 bps are available.

(b) When using an RS-232 cable manufactured by Mitsubishi Electric Corporation
The following cables are usable to connect the function extension board or special adapter of FXCPU.

For personal computer (RS-232 cable) RS-232/RS-422 
converter*3 For PLC CPU (RS-422 cable)

F2-232CAB (Mitsubishi Electric Corporation) *1*2

(For the 25-pin D-sub connector of the personal 
computer)

F2-232CAB-1 (Mitsubishi Electric Corporation) *2

(For the 9-pin D-sub connector of the personal 
computer)

AC30N2A (Mitsubishi Electric Corporation) *1

(For the 25-pin D-sub connector of the personal 
computer)

FX-232AW
(Mitsubishi Electric 
Corporation)

FX-232AWC
(Mitsubishi Electric 
Corporation)

FX-232AWC-H
(Mitsubishi Electric 
Corporation)
(FX series 
only)(Mitsubishi)

FX-422CAB (0.3 m) (Mitsubishi Electric Corporation)
FX-422CAB-150 (1.5 m) (Mitsubishi Electric 
Corporation)
(For connecting to QnACPU, ACPU, Motion CPU (A 
series), FX1CPU, FX2CPU, or FX2CCPU)

FX-422CAB0 (1.5 m) (Mitsubishi Electric Corporation)
(for connection with FX0/FX0S/FX0N/FX1S/FX1N/
FX2N/FX1NC/FX2NC/FX3G/FX3GC/FX3GE/FX3U/
FX3UC/FX3SCPU/AC30N2A)

RS-232 cable*1*2

GT01-C30R2-9S (Mitsubishi Electric Corporation)

GT01-C30R2-25P (Mitsubishi Electric Corporation)

F2-232CAB
Y990C*****

F2-232CAB-1
Y990C*****

F2-232CAB (F/FX/A)
  Y990C*****

F2-232CAB-1 (F/FX/A)
  Y990C*****

Incompatible product
Compatible product 

(with the description of (F/FX/A))
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*1 The following shows connection types that can be used with GT01-C30R2-9S.

*2 The following shows connection types that can be used with GT01-C30R2-25P.

Model Function extension 
board Special adapter Connector for personal 

computer

FX3U series, FX3UC 
series (FX3UC-□□-LT)

FX3U-232-BD -

9-pin D-subFX3U-232-BD, FX3U-
485-BD, FX3U-422-BD, 
FX3U-USB-BD, FX3U-
CNV-BD

FX3U-232ADP

FX3UC series (FX3UC-
□□/D, FX3UC-□□/DSS) - FX3U-232ADP 9-pin D-sub

FX3S series

FX3G-232-BD -

9-pin D-sub
-

FX3S-CNV-ADP
+
FX3U-232ADP

FX3G series
FX3G-232-BD -

9-pin D-sub
FX3G-CNV-BD FX3U-232ADP

FX3GC series - FX3U-232ADP 9-pin D-sub

FX3GE series FX3G-232-BD FX3U-232ADP 9-pin D-sub

FX2N series
FX2N-232-BD -

9-pin D-sub
FX2N-CNV-BD FX2NC-232ADP

FX1NC, FX2NC series - FX2NC-232ADP 9-pin D-sub

FX1S, FX1N series
FX1N-232-BD -

9-pin D-sub
FX1N-CNV-BD FX2NC-232ADP

Model Function extension 
board Special adapter Connector for the 

personal computer

FX3U series, FX3UC 
series (FX3UC-□□-LT)

FX3U-232-BD -

25-pin D-subFX3U-232-BD, FX3U-
485-BD, FX3U-422-BD, 
FX3U-USB-BD, FX3U-
CNV-BD

FX3U-232ADP

FX3UC series (FX3UC-
□□/D, FX3UC-□□/DSS) - FX3U-232ADP 25-pin D-sub

FX3S series

FX3G-232-BD -

25-pin D-sub
-

FX3S-CNV-ADP
+
FX3U-232ADP

FX3G series
FX3G-232-BD -

25-pin D-sub
FX3G-CNV-BD FX3U-232ADP

FX3GC series - FX3U-232ADP 25-pin D-sub

FX3GE series FX3G-232-BD FX3U-232ADP 25-pin D-sub

FX2N series

FX2N-CNV-BD FX0N-232ADP 9-pin D-sub

FX2N-232-BD -
25-pin D-sub

FX2N-CNV-BD FX2NC-232ADP

FX1NC, FX2NC series
- FX0N-232ADP 9-pin D-sub

- FX2NC-232ADP 25-pin D-sub

FX1S, FX1N series

FX1N-CNV-BD FX0N-232ADP 9-pin D-sub

FX1N-232-BD -
25-pin D-sub

FX1N-CNV-BD FX2NC-232ADP
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(c) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.
The following cables can be used when the built-in USB port of the FX3G or FX3GC or FX3GE or FX3S series is used 
for connection.

For other USB cables that can be used with FXCPU, refer to the following.
➟FX3U SERIES HARDWARE MANUAL

For the precautions on converters and cables, refer to the following.
➟3.3.3 ■2 When connecting GT Simulator3 with a PLC CPU

■6 Connecting with MELSEC iQ-F

*1 For how to install GX Works3, refer to the following.

➟GX Works3 Installation Instructions
*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 Monitoring-supported Controllers

(1) Access range
The following shows the access range for the direct CPU connection (serial) in the following configuration.

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer
GX Works3 *1

Windows-compatible printer

Personal computer

Connected 
station CPU

Relay module 1

Relay network 1

Relay network 2

Relay station 
CPU 1

Relay 
module 1

Relay 
module 2

Relay station 
CPU 2

Relay 
module 2
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(2) Single network (connection with MELSEC iQ-F)

○: Accessible, -: Inaccessible

*1 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE 
Field Network.

(3) Multiple networks (connection with MELSEC iQ-F)
For the direct CPU connection (serial), the CPUs on relay network 2 are inaccessible.

(4) Connection cable
The following shows the converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(5) When using an RS-232 cable manufactured by Mitsubishi Electric Corporation
The following cable is usable to connect the function extension board or special adapter of MELSEC iQ-F.

*1 The following shows connection types that can be used with GT01-C30R2-9S.

For the precautions on converters and cables, refer to the following.
➟3.3.3 ■2 When connecting GT Simulator3 with a PLC CPU

(6) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.
The following cables can be used when the built-in USB port of FX5UJ is used for connection.

Connected 
station Relay station

FX5CPU Relay 
network 1

Relay CPU

RCPU LHCPU LCPU QnCPU QSCPU QCPU (A 
mode)

QnACPU, 
MELDAS 

C6*
ACPU FX5CPU

○ CC IE Field - - - - - - - - ○*1

RS-232 cable*1

GT01-C30R2-9S (Mitsubishi Electric Corporation)

Model Function extension 
board Special adapter Connector for personal 

computer

FX5U
FX5UJ

FX5-232-BD - 9-pin D-sub

FX5U
FX5UC
FX5UJ

- FX5-232ADP 9-pin D-sub

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B
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(7) When using a USB cable manufactured by SANWA SUPPLY INC.
The following cables can be used when the built-in USB port of FX5UJ is used for connection.

(8) When using a USB adapter manufactured by ELECOM CO., LTD.
The following cables can be used when the built-in USB port of FX5UJ is used for connection.

■7 Connecting with the MELSECNET/H remote I/O station

*1 For how to install GX Developer, GX Simulator, or GX Simulator2, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
GX Works2 Installation Procedure Manual

*2 For the PLCs that can be monitored by GT Simulator3, refer to the following.

➟3.1.2 ■2 Mitsubishi Electric products

(1) Connection cable
The following shows converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using an RS-232 cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

USB cable/USB conversion adapter

KU-AMB530 (3 m) or KU-AMB550 (5 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

USB cable/USB conversion adapter

USB2-30 (3 m) + AD-USBBFTM5M

Personal computer side: USB TYPE-A Controller side: USB Mini-B

+

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Works3 Version Connection cable

Printer cable

PLC CPU *2

Personal computer

Windows compatible printer
GX Developer *1

GX Works2 *1

RS-232 cable

GT01-C30R2-6P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

Personal computer side: 9-pin D-sub connector Controller side: MINI-DIN6-pin
3. SIMULATION
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■8 Connecting with CC-Link IE Field Network head unit

(1) Connection cable 
The following shows converters and cables whose operations have been validated by Mitsubishi Electric Corporation.

(a) When using a USB cable manufactured by Mitsubishi Electric Corporation or Mitsubishi Electric 
System & Service Co., Ltd.

(b) When using a USB cable manufactured by ELECOM CO., LTD.

(c) When using a USB cable manufactured by LOAS CO., LTD.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

USB cable

MR-J3USBCBL3M (3 m) (Mitsubishi Electric Corporation)

GT09-C30USB-5P (3 m) (Mitsubishi Electric System & Service Co., Ltd.)

USB cable

USB-M53 (3 m)

USB cable

ZUM-430 (3 m)

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B

Personal computer side: USB TYPE-A Controller side: USB Mini-B
3 - 62 3. SIMULATION
3.2 Connecting



3

SI
M

U
LA

TI
O

N

■9 Connecting with MELDAS C6/C64

The conversion cable to connect GT Simulator3 and MELDAS C6/C64 must be configured by the user.
The following shows the connection diagram and specifications of the connector.

(1) Connection diagram

(2) Specifications of the connector
(a) Connector for the personal computer

Use a connector applicable to the personal computer.

(b) Connector for MELDAS C6/C64
Use a connector applicable to MELDAS C6/C64.
For details, refer to the following manuals.

➟Manual of MELDAS C6/C64

(c) Precautions for configuring a cable
The length of the conversion cable must be 15 m or shorter.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer 
(GT Simulator3) side

Signal name

MELDAS C6/C64 (TERMINAL) side

Pin No. Signal name

1 GND

-

-

-

6 SD (TXD)

-

11 GND

16 RD (RXD)

18 ER (DTR)

Cable connection and signal direction

GND

RD (RXD)

SD (TXD)

GND

DR (DSR)

CS (CTS)
3. SIMULATION
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3.2.3 Connecting with non-Mitsubishi Electric products

■1 Connecting with OMRON PLCs
(1) When using an RS-232 cable manufactured by Mitsubishi Electric System & Service Co., Ltd.

(2) When configuring an RS-232 cable
The following shows the connection diagram and specifications of the connector.

(a) Connection diagram

(b) Specifications of the connector
• Connector for the personal computer

Use a connector applicable to the personal computer.
• Connector for OMRON PLC

Use a connector applicable to the OMRON PLC.
For details, refer to the following manuals.

➟Manual of the OMRON PLC

(c) Precautions for configuring a cable
The length of the RS-232 cable must be 15 m or shorter.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

RS-232 cable

GT09-C30R20101-9P (For the 9-pin D-sub connector for the personal computer)

Personal computer 
(GT Simulator3) side

Signal name

OMRON-PLC side

Pin No. Signal name

1 FG

5 CS

7 FR

6 -

4 RS

3 RD

2 SD

8 ER

9 SG

Cable connection and signal direction

CD

RD (RXD)

SD (TXD)

ER (DTR)

SG

DR (DSR)

RS (RTS) 

CS (CTS)

-
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3.3 Precautions

➟3.3.1 Precautions for using GT Simulator3
3.3.2 Precautions for connecting with the controller simulators
3.3.3 Precautions for connecting with PLC CPU
3.3.4 Version of the project data to be simulated

3.3.1 Precautions for using GT Simulator3

■1 Display of GT Simulator3 and the GOT
The display of GT Simulator3 may differ from the display of the GOT.
Check the actual display of the GOT.

■2 Numerical display
If an invalid numerical value is stored when [Real] is selected for [Display Format] of [Numerical Display], the invalid 
numerical value is displayed in GT Simulator3. ([non] is displayed on the GOT.)

■3 Clock display
The clock display at simulation by GT Simulator3 depends on the clock data of the personal computer. (The GOT reads 
the clock data of the PLC CPU to use it.)
The setting [Automatically adjust clock for daylight saving changes] in the personal computer is not applicable. Do not 
enable [Automatically adjust clock for daylight saving changes].

■4 Hard copy function
The settings of [Invert], [Writing Notification Device], and [Writing Error Notification Device] of the hard copy function 
cannot be simulated.
The system information about the hard copy function cannot be simulated.

■5 Printer output
(1) Printer output

The data cannot be output directly by the report function or hard copy function.
Data will be output to a file (TXT, CSV, or BMP format) on the hard disk of the personal computer.
Output the file to a printer.

➟3.3.1 3.3.1 Precautions for using GT Simulator3

(2) When creating a table with the report function
Create a table as shown in example 1.
If a table is created as shown in example 2, the table will appear incorrectly in the output CSV file.

(3) When outputting the characters specified with a text print object by using the report function
Store characters in the specified devices according to the setting of [Display in order of High -> Low].
If the characters are not stored in the specified byte order, the characters are displayed incorrectly in the output CSV file.

➟8.32.5 [Text Print] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

 Table created with 
 GT Designer3 CSV file table

CSV file table
Example 2) Table created with
                    GT Designer3

Example 1)
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(4) When using a project where the output trigger is set to turn on frequently
Make sure that your personal computer has enough free hard disk space, and delete the output files as necessary.
The output files will not be deleted automatically even upon exit from GT Simulator3.

(5) When opening an output file on the personal computer
If you open an output TXT file by using a text editor such as WordPad or Notepad, character spacing may be misaligned 
on display.
If the character spacing is misaligned, adjust the character font or font size.

(6) System alarm when the hard copy is executed
GT21 and GS21 do not support the system alarm function.
The system alarm is not displayed when the hard copy is executed.
For the troubleshooting for the hard copy, refer to the following.

➟3.8.2 Troubleshooting for saving files

■6 Sound output
(1) Inapplicable simulator

The GT21 and GS21 simulators do not support the sound output function.

(2) Personal computer conditions
The sound output function is executed with the sound function (sound card) or speaker of the personal computer.
If the personal computer to be used cannot output sound, the sound output function is unavailable.

(3) Unmuting of GT Simulator3 at its startup
If you mute GT Simulator3 in Windows sound settings, GT Simulator3 is automatically unmuted at its startup.
However, if you mute all sounds on Windows, GT Simulator3 remains mute.

■7 Connecting with FXCPU
When setting an odd value of [Counter (current value)(C)] (16 bits) for the start device in the recipe function, use C199 
or earlier.

■8 When the project data has multi-channel
Only channel 1 can be simulated.
The other channels are ignored.
To monitor a device of other than channel 1, select [Search/Replace] → [Batch Edit] → [CHNo.] from the menu and set 
channel 1 for the debug target channel in GT Designer3.
Example) When channel 1 and 2 are used and channel 2 is to be simulated

Step 1 Change channel 1 to channel 3 in a batch.
Step 2 Change channel 2 to channel 1 in a batch.

For the batch edit of the channels, refer to the following.
➟11.8.4 Changing the set values in a batch (Batch Edit)

■9 Showing hidden folders
The following folders are hidden folders.
Users\(user name)\AppData\Local

To display the hidden folders, configure the setting in Windows.
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■10 Recipe information
Not available to GT21 and GS21.
Clicking a special function switch to which [Recipe Information] is set displays the recipe operation window, regardless 
of the setting of [Enable recipe file operation on the monitor] in the [Recipe Common Setting] dialog.
To display the recipe information, click the [Recipe Information] button in the simulation utility.

■11 Solutions when forgetting the administrator password for the operator authentication
Delete the operator management information file (AUTHINF.G2U) and register all operator management information 
again.
You can delete the operator management information file in the following procedure.

Step 1 Select [Delete operator information when starting] on the [Action setup] tab in the [Option] dialog.
Step 2 Start GT Simulator3.

The operator information file (AUTHINF.G2U) is deleted once, and a new file is created.

■12 Virtual drive V
To store image files in drive V and use them for parts displays, satisfy all the following conditions.

• Store the image files directly under drive V using the FTP server function that can run on Windows.
• Use IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg only for the file name and extension.
• Limit the total file size to less than 6 MB.
• Do not store any file other than IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg.

The files in drive V are deleted when a simulation is started, refreshed, or ended.
For details on parts displays, refer to the following.

➟8.8 Placing a Parts Display

■13 Screen save function
The screen is displayed in screen save mode even when GT Simulator3 is performing a simulation.
When Forced Screen Saver Enable signal (System signal 1-1.b1) is turned on, the GOT enters screen save mode and 
key input is disabled.
When Forced Screen Saver Enable signal (System signal 1-1.b1) is turned off, key input is enabled.
If you perform input operation with the mouse or keyboard or others in screen save mode, the first input will cancel the 
mode.
For the details of the system signal, refer to the following.

➟5.2.5 ■1 (1) System signal 1-1
The automatic screen saver function is not available.
3. SIMULATION
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3.3.2 Precautions for connecting with the controller simulators

■1 When starting GX Simulator from GT Simulator3
While GT Simulator3 is monitoring GX Simulator, GX Simulator cannot be started from GX Developer.
After exiting GT Simulator3, start GX Simulator from GX Developer again.

■2 When starting the controller simulator from GX Developer or others
(1) Using the activated controller simulator

When a controller simulator has been started from GX Developer or others, GT Simulator3 connects to the activated 
controller simulator.

(2) Starting the controller simulator in advance
GX Simluator2 is not started automatically at the simulation of GT Simulator3.
Start GX Simluator2 from GX Works2 in advance.
GX Simulator and MT Simlator2 are started automatically at the simulation of GT Simulator3.
Starting them from GX Developer or MT Developer2 in advance is not required.

(3) Exiting GX Simulator
After exiting GT Simulator3, exit GX Simulator.
If you exit GX Simulator before GT Simulator3, a communication error occurs in GT Simulator3.

■3 When using MT Simulator2
GT Simulator3 monitors MT Simulator2 as one of the PLC CPUs of GX Simulator2.
To monitor MT Simulator2, also start GX Simulator2.

■4 When simulating the project data that has the setting of a non-Mitsubishi Electric PLC
(1) When simulating project data using [Default] in [GX Simulator setting]

When the CPU type in [Option] is set to [MELSEC-A] in GT Simulator3, the data can be simulated in the device range of 
A4UCPU.

➟3.6.1 Setting options
For the device range in which the data can be simulated, refer to the following.

➟3.1.3 Available devices for monitoring

(2) When simulating project data using [Specify a GX Developer project] in [GX Simulator setting]
Specify a GX Developer project whose PLC series is [ACPU].
When the CPU type in [Option] is set to [MELSEC-A] in GT Simulator3, the data can be simulated in the device range of 
ACPU (specified PLC type).

➟3.6.1 Setting options
For the device range in which the data can be simulated, refer to the following.

➟3.1.3 Available devices for monitoring

■5 When simulating project data whose PLC type is [LCPU] in GX Simulator
When the CPU type in [Option] is set to [MELSEC-Q] in GT Simulator3, the data can be simulated in the device range of 
Q26UDHCPU.

➟3.6.1 Setting options
For the device range in which the data can be simulated, refer to the following.

➟3.1.3 Available devices for monitoring

■6 When simulating project data whose PLC type is [FX3UC]
When [GX Simulator setting] is [Option] in GT Simulator3 is set to [Specify a GX Developer project], the GX Developer 
project whose PLC type is [FX3UC] cannot be simulated.
Set [GX Simulator setting] in [Option] in GT Simulator3 to [Default], and simulate the project in the device range of the 
FX2N series.

➟3.6.1 Setting options

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■7 When simulating the buffer memory
The buffer memory can be simulated by setting [GX Simulator setting] in [Option] to [Specify a GX Developer project] in 
GT Simulator3 and specifying the GX Developer project to which I/O has been assigned.

➟3.6.1 Setting options
If [GX Simulator setting] in [Option] in GT Simulator3 is set to [Default], the buffer memory cannot be simulated because 
I/O has not been assigned.

■8 When simulating a project having the MELSEC redundant setting
GX Simulator does not support the simulation of the project having the MELSEC redundant setting.
To simulate such a project, establish a physical connection with a target CPU in the redundant system instead of GX 
Simulator.
Otherwise, system alarm occurs and the project is simulated incorrectly.

■9 When accessing a servo amplifier simultaneously with a GOT or software application
Do not monitor or write a device value to a servo amplifier simultaneously from a GOT, GT Simulator3, GT SoftGOT2000, 
and other MELSOFT applications (such as MR Configurator2).
Doing so may cause the incorrect display of parameters and others on the GOT and software applications, or a servo 
amplifier malfunction.
3. SIMULATION
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3.3.3 Precautions for connecting with PLC CPU

■1 When connecting GT Simulator3 with the function extension board of FXCPU
When connecting GT Simulator3 with the function extension board of FXCPU, configure the setting in GX Developer as 
follows.

Step 1 Disable [Operate communication setting] in the [PLC system(2)] tab of [PLC parameter].
Step 2 Set 0 in the special register (D8120) of FXCPU.

■2 When connecting GT Simulator3 with a PLC CPU
When connecting GT Simulator3 with a PLC CPU, note the following.

(1) Specifications and precautions for converters and cables
For the specifications and precautions for converters and cables, refer to the following.

➟Manual of each product

(2) When connecting or disconnecting the converter or cable that receives a 5 V DC power
Turn off the power on the PLC side, and then connect or disconnect the converter or cable that receives a 5 V DC power 
from the PLC side.

(3) When connecting or disconnecting the converter or cable that does not receive a 5 V DC power
Use the following procedure to connect or disconnect the converter or cable that receives an external power instead of 
the 5 V DC power from the PLC side.

Step 1 Touch an earth band or grounded metal to discharge static electricity of the cable and human body before 
operation.

Step 2 Turn off the personal computer.
Step 3 Turn off the converter.

Ground the FG terminal if provided.
Step 4 Connect or disconnect the converter or cable between the personal computer and the PLC.
Step 5 Turn on the converter.
Step 6 Turn on the personal computer.
Step 7 Start the software package.

3.3.4 Version of the project data to be simulated

Use GT Simulator3 of the same version as that of GT Designer3.
When using project data created in GT Designer3 of the version earlier than that of GT Simulator3, open the project data 
in GT Designer3 of the version same as that of GT Simulator3, and then save the data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.4 Simulation Procedure

➟3.4.1 Simulating the project being edited
3.4.2 Simulating a saved project

3.4.1 Simulating the project being edited

Simulate the project data being edited in GT Designer3.
➟■1 Connecting the controller simulator with GT Simulator3
■2 Connecting a PLC CPU with GT Simulator3

Simulators for different series can be used simultaneously.
However, simulators for the following series combinations cannot be used simultaneously.

• GOT2000 series and GOT SIMPLE series
• GOT1000 series and GOT-A900 series

■1 Connecting the controller simulator with GT Simulator3
Step 1 Start the controller simulator by the following operations.

• When using GX Simulator
GX Simulator is started automatically at the simulation of GT Simulator3.
Starting GX Simulator in advance is not required.
GT Simulator3 connects to GX Simulator which has been started from GX Developer.
For the details of GX Simulator, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
• When using GX Simulator2

Open project data on GX Works2, and start GX Simulator2.
For the details of GX Simulator2, refer to the following.

➟GX Works2 Version□ Operating Manual (Common)
• When using GX Simulator3

Open project data on GX Works3, and start GX Simulator3.
For the details of GX Simulator3, refer to the following.

➟GX Works3 Operating Manual
• When using MT Simulator2

Start GX Simulator2 in advance.
Open project data on GX Works2, and start GX Simulator2.
MT Simulator2 is started automatically at the simulation of GT Simulator3.
Starting MT Simulator2 in advance is not required.
For the details of MT Simulator2, refer to the following.

➟MT Developer2 Help
3.3.2 Precautions for connecting with the controller simulators

Step 2 Select [Tools] → [Simulator] → [Set] from the menu in GT Designer3.
The [Option] dialog appears in GT Simulator3.
Configure the option settings in GT Simulator3.*1

Some items cannot be set by this operation.
➟3.6.1 Setting options

*1 To simulate the project data that was simulated last time, select [Simulate] → [Start] from the menu.
For details, refer to the following.
➟3.6.3 Starting or exiting simulation

Step 3 Select [Tools] → [Simulator] → [Activate] from the menu in GT Designer3.
The simulation in GT Simulator3 starts.
When GT Simulator3 is in operation, simulation cannot be started in GT Designer3.

Step 4 Debug the project in GT Simulator3.

➟3.6.5 Operations of the screen for simulation
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Step 5 Update the project data in GT Designer3, and then check the update in GT Simulator3.
Check the update in GT Simulator3.

➟3.6.4 Updating the project to be simulated
Step 6 Select [Tools] → [Simulator] → [Exit] from the menu in GT Designer3.

GT Simulator3 exits.
➟3.6.6 Exiting GT Simulator3

■2 Connecting a PLC CPU with GT Simulator3
Step 1 Connect a PLC CPU with the personal computer.

➟3.1.2 Monitoring-supported Controllers
Step 2 Set the option of GT Simulator3*1.

Select [Tools] → [Simulator] → [Set] from the menu in GT Designer3.
The [Option] dialog appears in GT Simulator3.
Configure the option settings in GT Simulator3. *1

Some items cannot be set by this operation.
➟3.6.1 Setting options

*1 To simulate the project data that was simulated last time, select [Simulate] → [Start] from the menu.
For details, refer to the following.
➟3.6.3 Starting or exiting simulation

Step 3 Power on the PLC CPU.
Step 4 Select [Tools] → [Simulator] → [Activate] from the menu in GT Designer3.

The simulation in GT Simulator3 starts.
When GT Simulator3 is in operation, simulation cannot be started in GT Designer3.

Step 5 Debug the project in GT Simulator3.

➟3.6.5 Operations of the screen for simulation
Step 6 Update the project data in GT Designer3, and then check the update in GT Simulator3.

➟3.6.4 Updating the project to be simulated
Step 7 Select [Tools] → [Simulator] → [Exit] from the menu in GT Designer3.

GT Simulator3 exits.
➟3.6.6 Exiting GT Simulator3

(1) When [Connection] is set to [RS232] or [USB]
The setting of [Connection] is not retained after GT Designer3 is exited.
When you newly start GT Designer3, set [Connection] according to the connection type.

(2) When the controller setting is changed on GT Designer3
The setting of [Connection] is automatically switched to the default one that corresponds to the new 
controller setting.
Change the setting of [Connection] according to the connection type as necessary.
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3.4.2 Simulating a saved project

Simulate the saved project data.
➟■1 Connecting the controller simulator with GT Simulator3
■2 Connecting a PLC CPU with GT Simulator3

Simulators for different series can be used simultaneously.
However, simulators for the following series combinations cannot be used simultaneously.

• GOT2000 series and GOT SIMPLE series
• GOT1000 series and GOT-A900 seri

■1 Connecting the controller simulator with GT Simulator3
Step 1 Start the controller simulator by the following operations.

• When using GX Simulator
GX Simulator is started automatically at the simulation of GT Simulator3.
Starting GX Simulator in advance is not required.
GT Simulator3 connects to GX Simulator which has been started from GX Developer.
For the details of GX Simulator, refer to the following.

➟GX Developer Version□ Operating Manual (Startup)
• When using GX Simulator2

Open project data on GX Works2, and start GX Simulator2.
For the details of GX Simulator2, refer to the following.

➟GX Works2 Version□ Operating Manual (Common)
• When using GX Simulator3

Open project data on GX Works3, and start GX Simulator3.
For the details of GX Simulator3, refer to the following.

➟GX Works3 Operating Manual
• When using MT Simulator2

Start GX Simulator2 in advance.
Open project data on GX Works2, and start GX Simulator2.
MT Simulator2 is started automatically at the simulation of GT Simulator3.
Starting MT Simulator2 in advance is not required.
For the details of MT Simulator2, refer to the following.

➟MT Developer2 Help
3.3.2 Precautions for connecting with the controller simulators

Step 2 From the Windows start menu*1, select [MELSOFT]*2 → [GT Works3] → [GT Simulator3] to start GT 
Simulator3.

*1 Select [All Programs] on the [Start] screen, or select [Start] → [All Programs].
*2 [MELSOFT Application] appears for a version of GT Works3 earlier than 1.136S.

Step 3 The [GT Simulator3 Main Menu] dialog appears.
Configure the following settings, and click the [Activate] button.

1) [Select the simulator to be started]
Select the simulator to be started.
The following shows the items to be selected.
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• When [GOT2000 series] is selected
[GT27 Simulator]
[GT25 Simulator]
[GT23 Simulator]
[GT21 Simulator]

• When [GS series] is selected
[GS25 Simulator]
[GS21 Simulator]

• When [GOT1000 series] is selected
[GT16 Simulator]
[GT15 Simulator]
[GT14 Simulator]
[GT12 Simulator]
[GT11 Simulator]
[GT10 Simulator]

• When [GOT-A900 series] is selected
[A900 Simulator]
When [GOT1000 series] or [GOT-A900 series] is selected for simulating the project data, refer to the 
following.

➟GT Simulator3 Version1 Operating Manual for GT Works3
2) [Show this dialog at startup]

Select whether to display [GT Simulator3 Main Menu] dialog at next startup.
This setting can be configured from the option as well.

➟3.6.1 ■3 [Environmental Setting] tab
3) [Activate] button

Activates GT Simulator3.

Step 4 Configure the option settings in GT Simulator3.*1

➟3.6.1 Setting options
*1 To simulate the project data that was simulated last time, select [Simulate] → [Start] from the menu.

For details, refer to the following.
➟3.6.3 Starting or exiting simulation

Step 5 Open the project data, and start a simulation.

➟3.6.2 Opening a project
3.6.3 Starting or exiting simulation

Step 6 Exit GT Simulator3 after the simulation.

➟3.6.6 Exiting GT Simulator3

■2 Connecting a PLC CPU with GT Simulator3
Step 1 Connect a PLC CPU with the personal computer.

➟3.1.2 Monitoring-supported Controllers

Step 2 From the Windows start menu*1, select [MELSOFT]*2 → [GT Works3] → [GT Simulator3] to start GT 
Simulator3.

*1 Select [All Programs] on the [Start] screen, or select [Start] → [All Programs].
*2 [MELSOFT Application] appears for a version of GT Works3 earlier than 1.136S.

Step 3 The [GT Simulator3 Main Menu] dialog appears.
Configure the following settings, and click the [Activate] button.

1)

3)
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1) [Select the simulator to be started]
Select the simulator to be started.
The following shows the items to be selected.

• When [GOT2000 series] is selected
[GT27 Simulator]
[GT25 Simulator]
[GT23 Simulator]
[GT21 Simulator]

• When [GS series] is selected
[GS25 Simulator]
[GS21 Simulator]

• When [GOT1000 series] is selected
[GT16 Simulator]
[GT15 Simulator]
[GT14 Simulator]
[GT12 Simulator]
[GT11 Simulator]
[GT10 Simulator]

• When [GOT-A900 series] is selected
[A900 Simulator]
When [GOT1000 series] or [GOT-A900 series] is selected for simulating the project data, refer to the following.

➟GT Simulator3 Version1 Operating Manual for GT Works3
2) [Show this dialog at startup]

Select whether to display [GT Simulator3 Main Menu] dialog at next startup.
This setting can be configured from the option as well.

➟3.6.1 ■3 [Environmental Setting] tab
3) [Activate] button

Activates GT Simulator3.

Step 4 Configure the option settings in GT Simulator3.*1

➟3.6.1 Setting options
*1 To simulate the project data that was simulated last time, select [Simulate] → [Start] from the menu.

For details, refer to the following.
➟3.6.3 Starting or exiting simulation

Step 5 Power on the PLC CPU.
Step 6 Open the project data, and start a simulation.

➟3.6.2 Opening a project
3.6.3 Starting or exiting simulation

Step 7 Exit GT Simulator3 after the simulation.

➟3.6.6 Exiting GT Simulator3

When [Connection] is set to [RS232] or [USB]
When you newly start GT Designer3, [Connection] is set to [GX Simulator2] automatically.
Change the setting of [Connection] according to the connection type as necessary.
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3.5 Screen Layout of GT Simulator3

This section describes the screen layout of GT Simulator3.

1) Title bar
Displays the software name and the project name.

2) Menu bar
GT Simulator3 can be operated from pull-down menus.

➟3.5.1 Menus
3) Toolbar

GT Simulator3 can be operated by buttons.
➟3.5.2 Toolbar

4) Screen for simulation
The simulation contents are displayed on this screen.

5) Status bar
The GT Simulator3 status is displayed.

➟3.5.4 Status bar
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3.5.1 Menus

The following shows the configurations of the menu bar.
➟■1 [Project]
■2 [Display]
■3 [Set]
■4 [Simulate]
■5 [Tools]
■6 [Help]

■1 [Project]

■2 [Display]

■3 [Set]

■4 [Simulate]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Menu Description Shortcut key

[Open]

[Project]
Reads workspace format projects.
➟3.4.2 Simulating a saved project

Ctrl + O

[File]
Reads single file format projects.
➟3.4.2 Simulating a saved project

Ctrl + E

[Snap Shot]
Saves a screen as a file.
(BMP format and JPEG format)
➟3.7.1 Taking snap shots

Ctrl + H

[Printer Settings]
Set a printer.
➟3.7.2 ■4 Configuring the printer setting

-

[Page Settings]
Adjusts the page layout for printing.
➟3.7.2 ■3 Page setting

-

[Print Preview]
Displays a print preview.
➟3.7.2 ■2 Previewing print image

-

[Print]
Outputs the contents of the settings of the project into a file.
➟3.7.2 ■1 Printing

Ctrl + P

[Property] Displays the project information. -

[End] Exits GT Simulator3. Alt + F4

Menu Description Shortcut key

[Scroll Bar]
Switches display or non-display of a scroll bar.
➟3.7.9 Displaying scroll bars

-

[Full Screen Mode]
Sets and cancels the full screen mode.
➟3.7.10 Displaying the simulation screen in full screen mode

Alt + F9

Menu Description Shortcut key

[Keyboard]
Enables or disables the keyboard input.

➟3.7.4 Operating the numerical input or text input with a 
keyboard

-

Menu Description Shortcut key

[Start] Starts a simulation. F3

[End] Exits a simulation. Alt + F3

[Option]
Displays the [Option] dialog.
➟3.6.1 Setting options

-
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■5 [Tools]

■6 [Help]

3.5.2 Toolbar

1) [Opening a project] button
Reads workspace format projects.

2) [Opening a file] button
Reads single file format projects.

3) [Starting simulation] button
Starts a simulation.

4) [Exit simulation] button
Exits a simulation.

5) [Device Monitor] button
Starts or ends the device monitor.

6) [Resource Data] button
Refer to resource data.

7) [Option setting] button
Displays the [Option] dialog.

8) [Keyboard] button
Enables or disables the keyboard input.

Menu Description Shortcut key

[Start of Device Monitor], [End of Device Monitor]
Starts or ends the device monitor.
➟3.7.5 Using the device monitor

-

[Resource Data]
Refer to resource data.
➟3.7.6 Referring to resource data

Ctrl + R

[Script Error]
Displays the script error information.

➟3.7.7 Displaying a script error
-

[Object Script Error]
Not available to GT21 and GS21.
Displays the object script information.

➟3.7.8 Displaying an object script error
-

Menu Description Shortcut key

[GT Designer3 Help]
Displays GT Designer3 Help.
➟0 How to Use Help

F1

[Manual List] Lists the manuals. -

[Connection to MITSUBISHI ELECTRIC FA 
Global Website] Connects to the MITSUBISHI ELECTRIC FA Global Website. -

[About GT Simulator3]
Check the version of GT Simulator3.
➟2.2.1 ■13 (1) [About GT Designer3] dialog

-
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3.5.3 Screen for simulation

Right-click the simulate screen to display the following popup menu.

1) [Open]
• [Project]

Reads workspace format projects.
• [File]

Reads single file format projects.
2) [Start]

Starts a simulation.
3) [End]

Exits a simulation.
4) [Option]

Displays the [Option] dialog.
5) [Scroll Bar]

Switches display or non-display of a scroll bar.
6) [Full Screen Mode]

Not available to GT21 and GS21.
Sets and cancels the full screen mode.

7) [Set]
• [Keyboard]

Enables or disables the keyboard input.
8) [Tools]

• [Start of Device Monitor], [End of Device Monitor]
Starts or ends the device monitor.

• [Resource Data]
Refer to resource data.

• [Script Error]
Displays the script error information.

• [Object Script Error]
Not available to GT21 and GS21.
Displays the object script information.
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3.5.4 Status bar

1) Operation explanations
Displays the operation explanation.

2) How to connect the communication setting
Displays how to connect the communication setting.

3) Communication port of the communication setting
Displays the communication port or the communication setting.
This item is displayed only for the direct CPU connection.

4) Baud rate of the communication setting
Displays the baud rate or the communication setting.
This item is displayed only for the direct CPU connection.
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3.6 Basic Operations of GT Simulator3

➟3.6.1 Setting options
3.6.2 Opening a project
3.6.3 Starting or exiting simulation
3.6.4 Updating the project to be simulated
3.6.5 Operations of the screen for simulation
3.6.6 Exiting GT Simulator3
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3.6.1 Setting options

➟■1 [Communication settings] tab
■2 [Action Setup] tab
■3 [Environmental Setting] tab

■1 [Communication settings] tab

➟(1) When [GX Simulator] is selected for [Connection]
(2) When [GX Simulator2] is selected for [Connection]
(3) When [GX Simulator2/MT Simulator2] is selected for [Connection]
(4) When [GX Simulator3] is selected for [Connection]
(5) When [RS232] is selected for [Connection]
(6) When [USB] is selected for [Connection]

(1) When [GX Simulator] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) Description
Displays a controller name to be connected to each channel of the GOT.

3) [Connection]
Select a connection method for each channel of the GOT.

4) [Type]
Select a controller type to be connected.
The following shows the items to be selected.

• [MELSEC-A]
• [MELSEC-QnA]
• [MELSEC-Q]
• [MELSEC-Q(A-Mode)]
• [MELSEC-FX]

5) [Default]
Executes a simulation with a sequence program with the END instruction only.

6) [Specify a GX Developer project]
Select this item to execute a simulation with any sequence program.
To specify a sequence program, click the [Browse] button to select a GX Developer project.
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(2) When [GX Simulator2] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) Description
Displays a controller name to be connected to each channel of the GOT.

3) [Connection]
Select a connection method for each channel of the GOT.

4) Connection setting

Item Description

[Connect to activated GX Simulator2 (one of 
the projects)] Enables connecting to one module of GX Simulator2.

[Connect to activated GX Simulator2 (multiple 
projects)] Enables connecting to multiple modules of GX Simulator2.

Detail setting table

When you select [Connect to activated GX Simulator2 (multiple projects)], set the controller 
simulator to be monitored.

Match the settings with those of [Network] of the device set in the project.
When the GOT monitors the device of the host station, the device set in the project does 
not have the network number and station number settings. [0-FF] is set internally for the 
device.
Set a value corresponding to the value of the host station (0-FF) to [NW No] and [PC No.] 
according to the system configuration of the monitoring target.
When using a connection type that does not route a network such as serial connection, set 
[0] to [NW No.] and [255] to [PC No.].
If both of the following conditions are satisfied, no applicable station for monitoring exists. 
The GOT monitors the host station.
• A device of other stations is set in the project.
• No controller simulator on other stations is set in GT Simulator3.

The following shows the setting items.
• Checkbox Select corresponding checkbox to enable the setting.
• [Connecting simulator] Select a simulator to be connected.
• [Host] Select a simulator to be set as a host.
• [NW No.] Set the network number. The setting range is [0] to [239].
• [PC No.] Set the station number. The setting range is [0] to [255].
• [CPU No.] Set a CPU No. The setting range is [0] to [4].
• [Type] Displays the controller type.

• [Project Name] Set the project name for GX Simulator2. The following shows the 
available project formats.

• Workspace format project (*.gd2)
• Single file format project (*.GXW)

1)
2)

3)
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[Add Row] button
Adds a detail setting row in the detail setting table.
Up to seven rows can be added.

[Delete Row] button Deletes the detail setting row that is selected in the detail setting table.

Item Description
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(3) When [GX Simulator2/MT Simulator2] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) [Connection]
Select a connection method for each channel of the GOT.

3) [GX Simulator2 Setting]
Set the connection method for GX Simulator2.

Item Description

Detail setting table

Set the controller simulator to be monitored.
Match the settings with those of [Network] of the device set in the project.
When the GOT monitors the device of the host station, the device set in the project does 
not have the network number and station number settings. [0-FF] is set internally for the 
device.
Set a value corresponding to the value of the host station (0-FF) to [NW No] and [PC No.] 
according to the system configuration of the monitoring target.
When using a connection type that does not route a network such as serial connection, set 
[0] to [NW No.] and [255] to [PC No.].
If both of the following conditions are satisfied, no applicable station for monitoring exists. 
The GOT monitors the host station.
• A device of other stations is set in the project.
• No controller simulator on other stations is set in GT Simulator3.

The following shows the setting items.
• Checkbox Select corresponding checkbox to enable the setting.
• [NW No.] Set the network number. The setting range is [0] to [239].
• [PC No.] Set the station number. The setting range is [0] to [255].
• [CPU No.] Set a CPU No. The setting range is [0] to [4].
• [Project Name] Set the project name for GX Simulator2. The following shows the 

available project formats.
• Workspace format project (*.gd2)
• Single file format project (*.GXW)

[About the valid simulator setting] button Displays the description dialog of the valid simulator setting.

[Add Row] button
Adds a detail setting row in the detail setting table.
Up to four rows can be added.

[Delete Row] button Deletes the detail setting row that is selected in the detail setting table.

1)
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4) [MT Simulator2 Setting]
Set the connection method for MT Simulator2.

(4) When [GX Simulator3] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) [Connection]
Select a connection method for each channel of the GOT.

3) [GX Simulator3 Setting]

Item Description

Detail setting table

Set the controller simulator to be monitored.
Match the settings with those of [Network] of the device set in the project.
When the GOT monitors the device of the host station, the device set in the project does 
not have the network number and station number settings. [0-FF] is set internally for the 
device.
Set a value corresponding to the value of the host station (0-FF) to [NW No] and [PC No.] 
according to the system configuration of the monitoring target.
When using a connection type that does not route a network such as serial connection, set 
[0] to [NW No.] and [255] to [PC No.].
If both of the following conditions are satisfied, no applicable station for monitoring exists. 
The GOT monitors the host station.
• A device of other stations is set in the project.
• No controller simulator on other stations is set in GT Simulator3.

The following shows the setting items.
• Checkbox Select corresponding checkbox to enable the setting.
• [NW No.] Set the network number. The setting range is [0] to [239].
• [PC No.] Set the station number. The setting range is [0] to [255].
• [CPU No.] Set a CPU No. The setting range is [2] to [4].
• [Type] Select the model of the controller.
• [OS Type] Select the type of the OS.
• [Project Name] Set the project name for MT Simulator2. The following shows the 

available project formats.
• Workspace format project (*.mt2)
• Single file format project (*.MTW)

• [User Name] Set the user name for the project.
• [Password] Set the password for the project.

[About the valid simulator setting] button Displays the description dialog of the valid simulator setting.

[Add Row] button
Adds a detail setting row in the detail setting table.
Up to three rows can be added.

[Delete Row] button Deletes the detail setting row that is selected in the detail setting table.

1)
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Set the connection details for GX Simulator3.

Item Description

Detail setting table

Set the controller simulator to be monitored.
Match the settings with those of [Network] of the device set in the project.
When the GOT monitors the device of the host station, the device set in the project does 
not have the network number and station number settings. [0-FF] is set internally for the 
device.
Set a value corresponding to the value of the host station (0-FF) to [NW No] and [PC No.] 
according to the system configuration of the monitoring target.
When using a connection type that does not route a network such as serial connection, set 
[0] to [NW No.] and [255] to [PC No.].
If both of the following conditions are satisfied, no applicable station for monitoring exists. 
The GOT monitors the host station.
• A device of other stations is set in the project.
• No controller simulator on other stations is set in GT Simulator3.

The following shows the setting items.
• Checkbox

Enables a setting.
• [Host]

Set a simulator as the host station.
• [NW No.]

Set a network number.
The setting range is [0] to [239].

• [PC No.]
Set a station number.
The setting range is [0] to [255].

• [CPU No.]
Set a CPU number.
The setting range is [0] to [4].

• [Connecting Simulator No.]
Set the system number and CPU number appearing on the screen of GX Simulator3.
Enter the system number, the period (.), and the CPU number in the order shown on the 
GX Simulator3 screen.
Example)
On the following screen, [1.1] is applicable.

The setting range of the system number is [1] to [64].
The setting range of the CPU number is [1] to [4].

[About the valid simulator setting] button Displays the description dialog of the valid simulator setting.

[Add Row] button
Adds a detail setting row in the detail setting table.
Up to 32 rows can be added.

[Delete Row] button Deletes a detail setting row selected in the detail setting table.
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(5) When [RS232] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) Description
Displays a controller name to be connected to each channel of the GOT.

3) [Connection]
Select a connection method for each channel of the GOT.

4) [Type]
Select a PLC type to be connected.
The following shows the items to be selected.

• [MELSEC iQ-F]
• [MELSEC-A]
• [MELSEC-QnA]
• [MELSEC-Q]
• [MELSEC-Q(A-Mode)]
• [MELSEC-L]
• [MELSEC-FX]
• [MELDAS C6*]
• [OMRON SYSMAC]

5) [Communication port]
Select a communication port.
The setting range is [COM1] to [COM63].

6) [Baud rate]
Select a communication baud rate.
The following shows the items to be selected.

PLC type
Baud rate

In the normal mode In the high-speed mode

[MELSEC iQ-F]

[9.6Kbps] [9.6Kbps] [19.2Kbps] [38.4Kbps] 
[57.6Kbps] [115.2Kbps]

[MELSEC-Q]

[MELSEC-Q(A-Mode)]

[MELSEC-L]

[MELSEC-FX]

[MELSEC-A] [9.6Kbps] [9.6Kbps]

[MELSEC-QnA] [9.6Kbps] [9.6Kbps] [19.2Kbps] [38.4Kbps]

[MELDAS C6*] [19.2Kbps] [19.2Kbps]

1)
2)

3)

4)

5)

6)

7)

8)
9)
10)
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7) [High-speed mode]
Select this item to use the high-speed mode.
In the high-speed mode, the continuous simulation time is two hours.
When you select [MELSEC-A] or [MELDAS C6*] in the [Controller Type], this item is not be displayed.

8) [CPU No. switching GD device first No. (3 points)]
Set this item when selecting [MELSEC-Q] for [Type].
Set the start device number of the GOT data registers (GD) to specify a CPU number.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [CPU No. switching GD device first No. (3 points)] set in the [Controller Setting] window in GT 
Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

9) [Module No. switching GD device first No. (16 points)]
Set this item when selecting [MELSEC iQ-F] for [Type].
Set the start device number of the GOT data registers (GD) to specify module numbers.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [Module No. switching GD device first No. (16 points)] set in the [Controller Setting] window in 
GT Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

10) [Servo axis switching GD device first No. (16 points)]
Set this item when selecting [MELSEC iQ-F] for [Type].
Set the start device number of the GOT data registers (GD) to specify an axis number.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [Servo axis switching GD device first No. (16 points)] set in the [Controller Setting] window in 
GT Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

[OMRON SYSMAC] [9.6Kbps] [9.6Kbps] [19.2Kbps] [38.4Kbps] 
[57.6Kbps] [115.2Kbps]

PLC type
Baud rate

In the normal mode In the high-speed mode
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(6) When [USB] is selected for [Connection]

1) Connection configuration tree
Displays connection methods and connection settings for each channel of the GOT.

2) Description
Displays a controller name to be connected to each channel of the GOT.

3) [Connection]
Select a connection method for each channel of the GOT.

4) [Type]
Select a PLC type to be connected.
The following shows the items to be selected.

• [MELSEC iQ-R]
• [MELSEC iQ-L]
• [MELSEC iQ-F]
• [MELSEC-Q]
• [MELSEC-L]
• [MELSEC-FX]

5) [High-speed mode]
Select this item to use the high-speed mode.
In the high-speed mode, the continuous simulation time is two hours.
When you select [MELSEC-A] or [MELDAS C6*] in the [Controller Type], this item is not be displayed.

6) [CPU No. switching GD device first No. (3 points)]
Set this item when selecting [MELSEC iQ-R] or [MELSEC-Q] for [Type].
Set the start device number of the GOT data registers (GD) to specify a CPU number.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [CPU No. switching GD device first No. (3 points)] set in the [Controller Setting] window in GT 
Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

7) [Module No. switching GD device first No. (16 points)]
Set this item when selecting [MELSEC iQ-R] or [MELSEC iQ-F] for [Type].
Set the start device number of the GOT data registers (GD) to specify module numbers.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [Module No. switching GD device first No. (16 points)] set in the [Controller Setting] window in 
GT Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

1)
2)

3)

4)

5)

6)
7)
8)
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8) [Servo axis switching GD device first No. (16 points)]
Set this item when selecting [MELSEC iQ-R] or [MELSEC iQ-F] for [Type].
Set the start device number of the GOT data registers (GD) to specify an axis number.
The following shows the items to be selected.

• GT27, GT25, GT23, and GS25: [0] to [65520]
• GT21 and GS21: [0] to [2032]

Specify the value of [Servo axis switching GD device first No. (16 points)] set in the [Controller Setting] window in 
GT Designer3.
If you set a different number on GT Simulator3, the simulation is not performed properly.

■2 [Action Setup] tab

1) [GOT Type]
Displays the GOT model to be simulated.

2) [Zoom]
Available to GT21 and GS21.
Select the display magnification of the simulation screen.

3) [Standard Language]
Displays the standard language.

4) [Security]

5) [Internal Device Retention Setting]

6) [Initialize SRAM user area when starting]
Not available to GT21 and GS21.
Initializes the SRAM user area when starting a simulation.
The following functions save data to the SRAM user area.

• User alarm observation
• System alarm observation
• Logging function

Item Description

[Authentication Method] Displays the authentication method.

[Delete operator information when starting] Deletes the operator information when starting a simulation.

Item Description

[Retain internal device values in the 
embedded memory in cycles]

Saves the values of GOT internal devices to the SRAM user area at the specified intervals.
If this item is deselected, the values will be saved when GT Simulator3 exits.

[Cycle]
Set a time interval to save the values of GOT internal devices to the SRAM user area.
The setting range is [1] minute to [60] minutes.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)
4)

5)

6)

For GT21 and GS21

2)

7)
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• Recipe function
• Internal device retention

7) [Delete all resource data after reading project data]
Deletes all user data in the following folders when starting a simulation.
Folder A, B, E, F, G or lower hierarchies in the working folders
For the working folder, refer to the following.

➟3.1.5 ■3 Working folder

■3 [Environmental Setting] tab

1) [Display a project title in the title bar]
Displays the project name in the title bar.

2) [A dialog is displayed when ending GT Simulator3]
Displays a dialog when GT Simulator3 exits.

3) [Show the simulator selection dialog at startup]
Displays the [GT Simulator3 Main Menu] dialog at GT Simulator3 startup.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
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3.6.2 Opening a project

➟■1 Opening a workspace format project
■2 Opening a single file format project

■1 Opening a workspace format project

Step 1 Perform one of the following operations.
• Click the [Open Project] button on the toolbar.
• Select [Project] → [Open] → [Project] from the menu.
• Right-click the mouse and select [Open] → [Project] from the menu.

Step 2 The [Open Project] dialog (workspace format) appears.
Configure the following settings and click the [Open] button.

1) [Save Folder Path]
Select a location where the project data has been saved.

2) [Workspace/Project List]
Workspaces or projects which are saved are displayed.
If a workspace is double-clicked, the projects in the workspace are displayed.
Select a project to be opened.

3) [Workspace Name]
The selected workspace name is displayed.

4) [Project Name]
The selected project name is displayed.

5) [Open a Single File Format Project]
Click this button to switch the screen to the one for selecting a single file format project.

Step 3 The confirmation dialog is displayed.
Confirm the display and click the [Yes] button or the [OK] button,

Step 4 The simulation starts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)

5)
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■2 Opening a single file format project

Step 1 Perform one of the following operations.
• Click the [Open a File] button on the toolbar.
• Select [Project] → [Open] → [File] from the menu.
• Right-click the mouse and select [Open] → [File] from the menu.

Step 2 The [Open Project] dialog (single file format) appears.
Configure the following settings and click the [Open] button.

1) [Look in]
Select a location where the project data has been saved.

2) [File name]
Set a name for the project data to be simulated.

3) [Files of type]
Select a file format of the project data. GTX formant or GTXS format)

4) [Open workspace format project]
Switches the dialog to the one for selecting a workspace format project.

Step 3 The confirmation dialog is displayed.
Confirm the display and click the [Yes] button or the [OK] button,

Step 4 The simulation starts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)
2)

4)
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3.6.3 Starting or exiting simulation

■1 Starting simulation
Step 1 Perform one of the following operations.

• Click the [Start] button on the toolbar.
• Select the [Simulate] → [Start] from the menu.
• Right-click the mouse and select [Start] from the menu.

Step 2 The confirmation dialog is displayed.
Confirm the display and click the [Yes] button or the [OK] button,

Step 3 The simulation starts.

■2 Exiting simulation
Step 1 Perform one of the following operations.

• Click the [END] button on the toolbar.
• Select [Project] → [END] from the menu.
• Select the [Simulate] → [END] from the menu.
• Right-click the mouse and select [END] from the menu.
• Click the [Close] button on the title bar.

Step 2 Simulation exits.

■3 Switching the display language of GT Simulator3
The display language of GT Simulator3 is switched according to that of GT Designer3.
The following shows how to switch the display language.

Step 1 Exit GT Simulator3.
Step 2 Switch the display language of GT Designer3.

For how to switch the display language of GT Designer3 and precautions, refer to the following.
➟2.1.3 Switching the display language of GT Designer3

Step 3 Start GT Simulator3 again to switch the display language.

In the following cases, the display language of GT Simulator3 is not switched.
• GT Simulator3 is not exited before the display language of GT Designer3 is switched.
• After the display language of GT Designer3 is switched, GT Simulator3 is started before GT Designer3 is exited.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Direct CPU connection (serial)When GX Simulator is connected
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3.6.4 Updating the project to be simulated

When you start GT Simulator3 from GT Designer3, you can confirm the contents edited with GT Designer3 with GT 
Simulator3 without starting GT Designer3 again.

Step 1 Select [Tools] → [Simulator] → [Activate] from the menu in GT Designer3.
Step 2 Edit a project data with GT Designer3.
Step 3 Select [Tools] → [Simulator] → [Update] from the menu in GT Designer3.
Step 4 The project data of GT Simulator3 is updated.

Starting GT Simulator3 associating with GT Designer3
Updating the program to be updated can be available only when GT Simulator3 is started from GT Designer3.
When you start GT Simulator3 alone, updating the project is unavailable.

3.6.5 Operations of the screen for simulation

In GT Simulator3, use the mouse instead of touching the screen.
The input range is narrower than that of the GOT. Check the input by buzzer.

3.6.6 Exiting GT Simulator3

Step 1 Perform one of the following operations.
• Click the [END] button on the toolbar.
• Select [Project] → [END] from the menu.
• Select the [Simulate] → [END] from the menu.
• Right-click the mouse and select [END] from the menu.
• Click the [Close] button on the title bar.

Step 2 GT Simulator3 exits.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.7 Useful Functions of GT Simulator3

➟3.7.1 Taking snap shots
3.7.2 Printing the screen being simulated
3.7.3 Displaying the information of the project being simulated
3.7.4 Operating the numerical input or text input with a keyboard
3.7.5 Using the device monitor
3.7.6 Referring to resource data
3.7.7 Displaying a script error
3.7.8 Displaying an object script error
3.7.9 Displaying scroll bars
3.7.10 Displaying the simulation screen in full screen mode

3.7.1 Taking snap shots

Save a screen image of the simulation as a BMP format file or a JPEG format file.
Step 1 Select [Project] → [Snap Shot] from the menu.
Step 2 The [Save As] dialog appears.

Configure the following settings and click the [Save] button.

1) [Save in]
Select a location for saving a file.

2) [File name]
Set a file name of the screen image to be saved.

3) [Save as type]
Select the BMP format or the JPEG format.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.7.2 Printing the screen being simulated

Output a screen image of the simulation to a printer.

➟■1 Printing
■2 Previewing print image
■3 Page setting
■4 Configuring the printer setting

■1 Printing

Step 1 Select [Project] → [Print] from the menu.
Step 2 The [Print] dialog of Windows is displayed.

Click the [OK] button to start printing.

■2 Previewing print image

Step 1 Select [Project] → [Print Preview] from the menu.
Step 2 The print preview is displayed.

Precautions for using the print preview
The print preview of the simulator screen may look smaller than the actual simulator screen depending on the 
paper type or size, and the screen resolution.
Therefore, what is printed may not match the print preview.
Check what has been printed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Page setting

Step 1 Select [Project] → [Page Setup] from the menu.
Step 2 The [Page Setup] dialog is displayed.

Configure the following settings and click the [OK] button.

1) [Margin]
Set margins for the page to be printed.

2) [Reverse screen image]
Select this item to reverse colors of the screen image at printing.

3) [Reverse Mode]
Set a reverse method for the screen image.
The following shows the items to be selected.

• [Color]: Reverses whole colors of the screen image to be printed.
• [Black and White]: Reverses white to black of the screen image to be printed.

■4 Configuring the printer setting

Step 1 Select [Project] → [Print Setup] from the menu.
Step 2 The [Print] dialog of Windows is displayed.

Configure the settings for the printer (selecting a printer, paper size, direction of printing).

(1) Precautions for the printer used
GT Simulator3 retains the print settings by GOT model.
However, when you perform one of the following operations, the printer selected for [Set as default printer] 
in Windows is specified.

• Deleting the selected printer
• Selecting a printer whose name contains 31 characters or more

(2) Precautions for the print settings
Depending on the printer used, some print settings are not retained.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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3.7.3 Displaying the information of the project being simulated

The project title, project ID, and the data size of the project data that is being simulated are displayed.
Step 1 Select [Project] → [Properties] from the menu.
Step 2 The [Properties] dialog appears.

1) [Project Title]
Displays the title for the project.

2) [Project ID]
Displays the project ID.

3) [Data Size]
Displays the data size of the project data.

When the properties dialog box is displayed before executing the simulation
When the [Properties] dialog is displayed before executing the simulation, the project title, the project ID, and the 
data size of the previous simulation are displayed.
When the project data is not read, the project title, the project ID, and the data size are not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.7.4 Operating the numerical input or text input with a keyboard

Operate the numerical input or text input with the keyboard of a personal computer.

Perform one of the following operations to enable or disable the keyboard input.
• Select [Set] → [Keyboard] from the menu.
• Click the [Keyboard] button on the toolbar.
• Select [Set] → [Keyboard] from the right-click context menu.

The following shows how to operate the numerical input or text input with a keyboard.

*1 The operation on the target object varies depending on the setting in the [Environmental Setting] window ([Key Windows]).
For the details, refer to the following.

➟5.2.4 ■4 [Key Window]

Keyboard operation GOT key code Operation on the numerical input Operation on the text input

[Back space] 0008h Delete the character on the cursor.

[Enter]*1 000Dh Write the entry to a specified device, display the cursor on the target object, move the cursor 
to a different object, or close the key window.

[Esc] 001Bh Cancel the entry.

[-] (Hyphen) 002Dh Reverse the sign of the value. -

[.] (Period) 002Eh Enter a decimal point. -

[0] to [9] 0030h to 0039h Enter a numeric character.

Enter a character. (ASCII or Unicode 2.1-
compatible)[A] to [Z], [a] to [z] 0041h to 005Ah, 0061h to 

007Ah
Enter a numeric character in hexadecimal ([A] 
to [F], [a] to [f]).

Symbol keys Character codes (ASCII) -

Enter text (such as hiragana 
or kanji characters).

Character codes (Unicode) - Enter text. (Unicode 2.1-compatible)

[→], [←], [↑], [↓] 0080h, 0081h, 0082h, 0083h Move the cursor to a different object.

[Home] 0084h - Convert the entry to kanji or Simplified 
Chinese characters.

[Page Up] 0085h - Select the previous candidate.

[Page Down] 0086h - Select the next candidate.

[End] 0087h
-

Confirm the entry, or select the next group of 
hiragana characters to be converted to kanji 
characters.

[Delete] 0088h Delete all the entered characters.

[Ctrl] + [→], [Ctrl] + [←] 0090h, 0091h Move the cursor on the target object.

[Ctrl] + [↑], [Ctrl] + [↓] FFFAh, FFFBh Increment or decrement the value. -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.7.5 Using the device monitor

The device monitor function monitors the devices of a controller connected to GT Simulator3.
You can change the current values of devices, checking the project operations efficiently.

■1 Specifications of the device monitor

(1) Starting the device monitor
When connection is established between GT Simulator3 and a controller simulator or Mitsubishi Electric equipment, you 
can start the device monitor during simulation only.
If connection is established between GT Simulator3 and non-Mitsubishi Electric equipment by using the direct CPU 
connection, you cannot start the device monitor.

(2) Devices that can be monitored
The device monitor function monitors GOT internal devices and controller devices.
For the devices that can be monitored by GT Simulator3, refer to the following.

➟3.1.3 Available devices for monitoring

(3) Specifications of the free registration list
A created free registration list is retained after GT Simulator3 exits.
Up to 32 free registration lists can be created.
Up to 32 characters are available for a free registration list name.
The following characters cannot be used in a free registration list name.
\ / : ; * ? " < > | .
Up to 6 free registration windows can be open simultaneously.
Up to 256 devices are registrable in one free registration list.

■2 How to use the device monitor

➟(1) Starting or ending the device monitor
(2) Creating or editing a free registration list
(5) Deleting a free registration list

(1) Starting or ending the device monitor

(a) Starting the device monitor
While GT Simulator3 is performing a simulation, perform one of the following operations to start the device monitor.

• Select [Tool] → [Start of Device Monitor] from the menu.
• Click the [Device Monitor] button on the toolbar.
• Select [Tool] → [Start of Device Monitor] from the right-click context menu.

(b) Ending the device monitor
Perform one of the following operations to end the device monitor.

• Select [Tool] → [End of Device Monitor] from the menu of GT Simulator3.
• Select [File] → [Exit] from the menu of the device monitor.
• Click the [Close] button on the title bar of the device monitor.
• On the GT Simulator3 screen, select [Tool] → [End of Device Monitor] from the right-click context menu.
• Exit GT Simulator3.

(2) Creating or editing a free registration list

Register a device in a free registration list to test the device for correct operation.
After changing the device value, you can check the project operations.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Creating or editing a free registration list
The following shows the procedure for creating or editing a free registration list.

Step 1 Perform one of the following operations to display a free registration window.
• Select [Window] → [New Free Registration List] from the menu.
• Double-click [New] under [Free Reg] in the [Project] window.
• Double-click a target free registration list under [Free Reg] in the [Project] window.

For information on how to import a free registration list and add it as a new list, refer to the following.
➟3.7.5 ■2 (3) Importing a free registration list

Step 2 Register, edit or delete a device in the free registration window.

➟3.7.5 ■4 (3) Free registration window

(b) Changing the name of a free registration list
Select a free registration list, and click it again or press the [F2] key on the keyboard to edit its name.

(c) Deleting a device
Select a device and press the [Delete] key on the keyboard to delete the device.

(3) Importing a free registration list

Import a free registration list file in the CSV or Unicode text format.
The following shows the procedure for importing a free registration list.

Step 1 Perform one of the following operations in the [Project] window according to the import method.
• To import a free registration list and add it as a new list, select [New].
• To overwrite an existing free registration list with an imported list, select the target existing free 

registration list.
• To import multiple free registration lists, select [Free Reg] at the top of the tree.

Step 2 Perform one of the following operations to display the [Open] dialog.
• Select [File] → [Import Free Registration List] from the menu.
• In the [Project] window, click the [Im] button.
• Right-click the item selected in step 1, and select [Import] from the menu.

Step 3 Select a free registration list file and click the [Open] button to import the file.
When importing multiple files, you can import CSV files and Unicode text files together.
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(4) Exporting a free registration list

Export a free registration list to a CSV or Unicode text file.
You can export one free registration list, or export all free registration lists collectively.
The following shows the procedure for exporting one free registration list.

Step 1 In the [Project] window, select a free registration list to be exported.
Step 2 Perform one of the following operations to display the [Save As] dialog.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click the free registration list to be exported, and select [Export] from the menu.

Step 3 Set [File name] and [Save as type], and click the [Save] button to export the free registration list.

The following shows the procedure for exporting all free registration lists collectively.
Step 1 In the [Project] window, select [Free Reg] at the top of the tree.
Step 2 Perform one of the following operations to display a dialog where you can select a file format.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click [Free Reg] at the top of the tree, and select [Export] from the menu.

Step 3 Select a file format and click the [OK] button to display the [Browse For Folder] dialog.
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Step 4 Select an export destination and click the [OK] button to export the free registration lists.

The exported free registration lists are editable with spreadsheet software or others.
The following shows the layout of an exported free registration list.

1) Version
Version of the free registration list.

2) List type
Type of a list.

• 0: Free registration list
3) List name

Name of the free registration list.
For the name specifications, refer to the following.

➟3.7.5 ■1 (3) Specifications of the free registration list
4) Number of devices

Number of the registered devices.
Up to 256 devices are registrable in one free registration list.

5) No.
Registered device number.

6) Device
Registered device.

7) Data type
Data type of a device

• BIT: [Bit]
• BIN8: [Byte [Signed]]
• BIN8_Unsigned: [Byte [Unsigned]/Bit String [8-bit]]
• BIN16: [Word [Signed]]
• BIN16_Unsigned: [Word [Unsigned]/Bit String [16-bit]]
• BIN32: [Double Word [Signed]]
• BIN32_Unsigned: [Double Word [Unsigned]/Bit String [32-bit]]
• BIN64: [Quad Word [Signed]]
• BIN64_Unsigned: [Quad Word [Unsigned]/Bit String [64-bit]]

8) Display format
Display format of a device.

• BIN: [Binary]
• OCT: [Octal]
• DEC: [Decimal]
• HEX: [Hexadecimal]

9) Comment
Comment set for a device.
Up to 255 characters can be set for one comment.

1)
2)

3)
4)

5)

6) 7) 8) 9)
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(5) Deleting a free registration list

The following shows the procedure for deleting a free registration list.
Step 1 In the [Project] window, select a free registration list to be deleted.
Step 2 Perform one of the following operations to display a confirmation dialog.

• Press the [Delete] key on the keyboard.
• Right-click the free registration list to be deleted, and select [Delete] from the menu.

Step 3 Click the [Yes] button to delete the list.

■3 Precautions

(1) Monitoring performance of GT Simulator3
An increase in the number of monitored devices causes monitoring performance degradation in GT Simulator3.

(2) Precautions for exporting a free registration list
When a free registration list contains characters that cannot be represented in ASCII or Shift JIS code, export the list to 
a Unicode text file.
If you export the list to a CSV file, such characters are not output properly.

(3) Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

■4 [Device Monitor] window

1) Title bar
Displays the device monitor operation status.

2) Menu bar
Displays the operation menus of the device monitor.

➟(1) Menus
3) Toolbar

Displays the operation buttons of the device monitor.
➟(2) Toolbar
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4) [Project] window

5) Work window
An area in which free registration windows appear

➟(3) Free registration window
6) Editor tab

Displays the tabs corresponding to the windows opened in the work window.
To bring an open window to the foreground in the work window, select its tab.

7) Status bar
Displays the description of a selected menu.

(1) Menus
(a) [File]

(b) [View]

(c) [Online]

(d) [Window]

• Expand all button, collapse all button
Expands or collapses all items in the tree.

• [Im] button
Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the 
following.
➟3.7.5 ■2 (3) Importing a free registration list

• [Ex] button
Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the 
following.
➟3.7.5 ■2 (4) Exporting a free registration list

• [Free Reg]
Displays created free registration list names.

• [New]
Creates a free registration list.

• Pull-down menu button
Lists the open windows in the work window.
To bring an open window to the foreground in the work window, 
select it from the pull-down menu.

Expand all button, collapse all button

Pull-down menu button

Menu Description Shortcut key

[Import Free Registration List]

Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the 
following.

➟3.7.5 ■2 (3) Importing a free registration list

Alt + I

[Export Free Registration List]

Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the 
following.

➟3.7.5 ■2 (4) Exporting a free registration list

Alt + E

[Exit] Ends the device monitor. -

Menu Description Shortcut key

[Toolbar] Displays or hides the toolbar. -

[Status Bar] Displays or hides the status bar. -

Menu Description Shortcut key

[Start] Starts the device monitor. F3

[Stop] Stops the device monitor. Alt+F3

Menu Description Shortcut key

[New Free Registration List] Create a free registration list. -

[Cascade] Displays open windows in a stack in the work window. -

[Arrange Sideways] Tiles open windows side by side in the work window. -
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(e) [Help]

(2) Toolbar

1) [Start the communication] button
Starts the device monitor.

2) [Stop the communication] button
Stops the device monitor.

3) [Display all open windows in a stack (cascade)] button
Displays open windows in a stack in the work window.

4) [Display all open windows in a horizontal direction] button
Tiles open windows side by side in the work window.

5) [Display all open windows in a vertical direction] button
Tiles open windows horizontally in the work window.

6) [Close all the inactive windows] button
Closes all open windows except the selected one in the work window.

7) [Create a new horizontal tab group] button
Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in a pane immediately underneath the current 
pane.
Tabs are movable between the editor tabs of panes.

8) [Create a new vertical tab group] button
Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in the immediately right pane.
Tabs are movable between the editor tabs of panes.

9) [Display GT Designer3 Help] button
Displays GT Designer3 Help.

[Arrange Lengthways] Tiles open windows horizontally in the work window. -

[Close Inactive Windows] Closes all open windows except the selected one in the work 
window. -

[New Horizontal Tab Group]

Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in 
a pane immediately underneath the current pane.
Tabs are movable between the editor tabs of panes.

-

[New Vertical Tab Group]

Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in 
the immediately right pane.
Tabs are movable between the editor tabs of panes.

-

Menu Description Shortcut key

[GT Designer3 Help] Displays GT Designer3 Help. F1

Menu Description Shortcut key

1) 3) 5) 7)

2) 4) 6)

9)

8)
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(3) Free registration window

1) [Device]
Set a device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of a device.
The following shows the items to be selected.

• [Bit]
• [Byte [Unsigned]/Bit String [8-bit]]
• [Word [Unsigned]/Bit String [16-bit]]
• [Double Word [Unsigned]/Bit String [32-bit]]
• [Quad Word [Unsigned]/Bit String[64-bit]]
• [Byte [Signed]]
• [Word [Signed]]
• [Double Word [Signed]]
• [Quad Word [Signed]]

3) [Current Value]
Displays the current value of a device.
The set value is changeable.
If a communication error occurs, [--] is displayed.
The setting range of [Current Value] depends on the device.

4) [Display Format]
Select the display format of a device.
The following shows the items to be selected.

• [Binary]
• [Octal]
• [Decimal]
• [Hexadecimal]

5) [Comment]
Set a comment for a device.
Up to 255 characters can be set for one comment.

1) 2) 3) 4) 5)
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3.7.6 Referring to resource data

Refer to alarm log files, recipe files, data log files, operation log files, and image files (such as hard copies) saved in a 
personal computer.

Step 1 Perform one of the following operations to display the [Refer To Resource Data] dialog.
• Select [Tool] → [Resource Data] from the menu.
• Click the [Resource Data] button on the toolbar.
• Select [Tool] → [Resource Data] from the right-click context menu.

Step 2 Configure the following settings and click the [Open] button to display the resource data.

1) [Look in]
Select the storage location of resource data.

2) [File name]
Select resource data to be referred to.

3) [Files of type]
Select the file type of resource data.

• CSV Files (*.csv): CSV format
• Unicode Text Files (*.txt): Unicode text format
• Bitmap Files (*.bmp): BMP format
• JPEG Files (*.jpg): JPEG format

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3.7.7 Displaying a script error

Displays the script error information.
For the script function, refer to the following.

➟9.9.14 ■3 (5) List of script execution error codes
Step 1 Perform one of the following operations.

• Select [Tool] → [Script Error] from the menu.
• Select [Tool] → [Script Error] from the right-click context menu.

Step 2 The [Script Error Info.] dialog is displayed.

1) [Script No.]
The script No. of the script in which an error occurs is displayed.

2) [Error No.]
The error code of the error is displayed.

3) [Error message]
Displays the error contents.

4) [Retry flag] button
Retries the script.
If a screen in which no script runs is displayed on the simulator screen, the retry is not performed.

5) [Clear] button
Clears the displayed error message by performing the following.
If a screen in which no script runs is displayed on the simulator screen, the error message is not cleared.

• GS14.b0, b7, b8, and b12 store 0
• GS15 stores -1
• GS16 to GS47 store 0

For the details of the GOT internal devices, refer to the following.
➟12.1.3 GOT special register (GS)

When the error has not been cleared, the error message is displayed again.
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3.7.8 Displaying an object script error

Displays the object script information.
For the object script function, refer to the following.

➟9.10.9 ■3 (5) List of object script execution error codes
Step 1 Perform one of the following operations.

• Select [Tool] → [Object Script Error] from the menu.
• Select [Tool] → [Object Script Error] from the right-click context menu.

Step 2 The [Object Script Error Info.] dialog is displayed.

1) [Script User ID]
The user ID of the script in which an error occurs is displayed.

2) [Error No.]
The error code of the error is displayed.

3) [Error message]
Displays the error contents.

4) [Retry Flag] button
Retries the object script.
If a screen in which no script runs is displayed on the simulator screen, the retry is not performed.

5) [Clear] button
Clears the displayed error message by performing the following.
If a screen in which no script runs is displayed on the simulator screen, the error message is not cleared.

• GS80.b0, b7, b8, and b12 store 0
• GS81 stores -1
• GS82 to GS113 store 0

For the details of the GOT internal devices, refer to the following.
➟12.1.3 GOT special register (GS)

When the error has not been cleared, the error message is displayed again.
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3.7.9 Displaying scroll bars

Step 1 Perform one of the following operations.
• Select [Display] → [Scroll bar] from the menu.
• Right-click the mouse and select [Scroll bar] from the menu.

Step 2 A scroll bar appears.

(1) Displaying the scroll bar
When resolutions of the GOT model to be simulated are lower than the window size, the scroll bar is not 
displayed.

(2) Scrolling the screen
When GT Simulator3 is activated, the screen can be scrolled by a wheel of a mouse.
The vertical scroll is prioritized.
Scrolling with the [PageUp] key and the [PageDown] key is unavailable.
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3.7.10 Displaying the simulation screen in full screen mode

The simulation screen can be displayed on the personal computer in a full screen.
➟■1 Executing the full screen display
■2 Canceling the full screen display

■1 Executing the full screen display
Step 1 Perform one of the following operations.

• Press the [Alt] key and the [F9] key.
• Select the [View] → [Full Screen Mode] from the menu.
• Right-click the mouse and select [Full Screen Mode] from the menu.

Step 2 The confirmation dialog for switching the full screen display appears.
Click the [OK] button, and then GT Simulator3 is displayed in a full screen.
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■2 Canceling the full screen display
Step 1 Perform one of the following operations.

• Press the [Alt] key and the [F9] key.
• Right-click the mouse and select [Full-screen display] from the menu.

Step 2 The confirmation dialog for switching the full screen display appears.
Click the [OK] button, and a full screen display is canceled.

(1) Operation during the full screen display
During the full screen display, operations for [Open], [Start], [END], and [Option] are available.
To execute an operation other than above, cancel the full screen display.

(2) Display during the full screen display
If a screen is switched to a full screen when resolutions of a personal computer are different from that of the 
project data, the display of GT Simulator3 is fixed to the upper left of the display of the personal computer.
The screen cannot be moved.
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3.8 Troubleshooting

➟3.8.1 Error messages (GOT2000 Series simulator)
3.8.2 Troubleshooting for saving files

3.8.1 Error messages (GOT2000 Series simulator)

The following shows error messages displayed when using GOT2000 Series simulator, details of error, error causes and 
corrective actions.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Error message Details of error and cause Corrective action

The Adobe Reader is not installed properly.
Install the Adobe Reader.

• The Adobe Reader is not installed.
• The Adobe Reader is not installed properly.

Uninstall the Adobe Reader and install again.

The manual file does not exist.
Install the manual.

• The GT Manual is not installed.
• The GT Manual is not installed properly.

Uninstall the GT Manual and install again.

GT Simulator3 is not installed properly. The product registry for GT Simulator3 does not 
exist. Uninstall GT Simulator3 and install again.

The project file cannot be accessed. The specified project data cannot be accessed. Check the access privileges of the project data.

The project file does not exist. The project data does not exist in the location with 
specified path.

Specify the path for a location where project data 
exists.

The PLC type of the project differs from the GT 
Simulator3 setting.

The PLC type of the read project differs from the GT 
Simulator3 setting.

Set the same PLC type for the project data created 
with GT Designer3 and GT Simulator3.

The GOT type of the project differs from the GT 
Simulator3 setting.

The GOT type of the read project differs from the 
GT Simulator3 setting.

Set the same GOT type for the project data created 
with GT Designer3 and GT Simulator3.

Reading has failed.
Check the followings and retry.
• Data size of screen and number of data points
• Available space of the disk
• Access privilege for the project file
• The project file is incorrect or damaged<CODE: 

%d-%d>

The size of the screen data is too large.
Check the data size of the screen.

➟3.1.1 Simulation-supported GOTs

Hard disk space is insufficient. Prepare 200MB or more for the hard disk space.

The project data cannot be accessed. Check the access privileges of the project data.

The project settings are incorrect. Check the settings with GT Designer3.

• The project data is not the one for GOT.
• The project data is damaged.

Use the correct project data or the project data that 
is not damaged.

Reading preparation has failed.
Check the followings and retry.
• Dialog display
• Waiting for offline mode

A message such as [This function is unavailable.] is 
displayed on the screen and reading is unavailable.

Select the [OK] button on the dialog to delete the 
message, then retry reading.

Internal processing other than the above is waited 
to be completed. Retry reading after a while.

Configuring the operating environment has failed.
Check the followings and retry.
• Available space of the disk
• Access privilege for a file

Hard disk space is insufficient. Prepare 200MB or more for the hard disk space.

Files required for the GT Simulator3 operations 
cannot be accessed.

Check that GT Simulator3 already has been 
activated.

GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

Failed to delete the user data.
• Close the opened user data.
• Check the access privilege for a file.

Deleting the user data after reading the screen data 
has failed.

• When the user data is opened by other software, 
close the file.

• Check the access privilege for a file.

Specified project is incorrect or is not a readable 
format.
Specify the project again.

• The GT Designer2 project is not in the workspace.
• The project is not saved in GT Designer2 (the 

project is not registered in the [*.GTE] format).

• Specify the GT Designer2 project in the 
workspace.

• Specify the project saved in GT Designer2 (the 
project that is registered in the [*.GTE] format).

The simulation cannot be closed.
Close the simulate screen and retry.

A message such as [This function is unavailable.] is 
displayed on the screen and GT Simulator3 cannot 
be closed normally.

Select the [OK] button on the dialog to delete the 
message, then close GT Simulator3 again.

Problems occur internally and GT Simulator3 
cannot be closed.

Select the [OK] button on the dialog and close GT 
Simulator3 after a while.

GT Simulator3 cannot be closed.
Close all dialogs and print previews that are being 
displayed.

• Dialogs or pint previews are displayed.
• Waiting for completion of internal process.

Close all dialogs and print previews that are being 
displayed.
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Log off or shut down Windows after closing GT 
Simulator3.

Log-off or shut-off processing was executed before 
closing GT Simulator3.

Log off or shut-off processing after closing GT 
Simulator3.

This function is unavailable. A function that is unusable in GT Simulator3 has 
been selected. Click the [OK] button.

Taking snap shots has failed.
• GT Simulator3 was closed in an incorrect status 

previously.
• Incorrect processing is activated.

• Restart GT Simulator3.
• Restart the personal computer and restart GT 

Simulator3.

The GX Developer project file is not correct. The project specified in [GX Developer Project] of 
the [Option] dialog does not exist.

Check that the specified GX Developer project 
exists.

The path name is too long. The GX Developer project saved in a folder of deep 
hierarchy is set.

Set the GX Developer project again in the [Option] 
dialog.

A communication error has occurred.
• Retry: Retries the communication.
• Cancel: All the future communications are not 

executed.
To execute the simulation, restart GT Simulator3 
(GT**).
<ES:xxxxxxxx>

• A cable is disconnected.
• A cable is broken.

Check the causes on the left and select the 
corresponding button on the dialog box.

[Retry]
Retries the communication.
[Cancel]
All the future communications are not executed.
To execute the simulation, restart GT Simulator3.

The transmission speed (baud rate) is incorrect.

The PLC type of the destination PLC CPU differs 
from that of the project.

This version of Easysocket is incorrect! GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

Easysocket is not installed! GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

GX Simulator is not installed!
• GX Simulator is not installed.
• GX Simulator is not installed properly.

Install GX Simulator.

This version of GX Simulator cannot operate! The version of installed GX Simulator is old. Install GX Simulator Version 5.40E or later.

GT Simulator3 cannot work, since language version 
for GT Simulator3 is different from one for GX 
Simulator!

GT Simulator3 cannot work, since language version 
for GT Simulator3 is different from one for GX 
Simulator.

Install GX Simulator with the same language 
version as GT Simulator3.

Project path of GX Developer cannot be acquired.
Cause
• GT Simulator3 is not installed properly.
• Unsupported CPU type is specified.
• Registry is corrupted.

• Registry information related to the project path of 
GX Developer is corrupted.

• Unsupported CPU type is specified.

Set the GX Developer project again in the [Option] 
dialog.

GT Simulator3 is not installed properly. Uninstall GT Simulator3 and install again.

The CPU type specified in GT Simulator3 differs 
from the one specified in GX Developer.

Change the CPU type in the Option setting or check 
the settings in the GX Developer project.

The CPU type settings are incorrect. Change the CPU type of the GX Developer project.

Failed to start Shared memory server (Vlinks.exe).
<ES:****>
********************

Easysocket may not be installed properly. Reinstall the latest version of MELSOFT 
application.

• MELSOFT application was closed incorrectly.
• Incorrect processing is activated.

• Restart the personal computer and restart GT 
Simulator3.

• Reinstall the latest version of GT Simulator3, GX 
Simulator, and GX Developer.

Failed to initialize GX Simulator.
<ES:****>
******************** error

Easysocket may not be installed properly. Reinstall the latest version of MELSOFT 
application.

GX Simulator may not be installed properly. Uninstall GX Simulator and install again.

• MELSOFT application was closed incorrectly.
• Incorrect processing is activated.

• Restart the personal computer and restart GT 
Simulator3.

• Reinstall the latest version of GT Simulator3, GX 
Simulator, and GX Developer.

Failed to start GX Simulator.
<ES:****>
********************

Easysocket may not be installed properly. Reinstall the latest version of MELSOFT 
application.

GX Simulator may not be installed properly. Uninstall GX Simulator and install again.

Install path of GT Simulator3 cannot be acquired. GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

Parameter file does not exist.
GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

An incorrect GX Developer project may be set. Create a new GX Developer project.

Program file does not exist.
GT Simulator3 may not be installed properly. Uninstall GT Simulator3 and install again.

An incorrect GX Developer project may be set. Create a new GX Developer project.

The memory for starting GX Simulator is 
insufficient. Dynamic memory is insufficient.

Reserve the enough memory capacity.
• Close unnecessary applications.
• Check the hard disk space.

Error message Details of error and cause Corrective action
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The project (GX Developer) is incorrect.
Project cannot be transferred to GX Simulator.

Incorrect program exists in the GX Developer 
project folder. Create a new GX Developer project.

Unsupported CPU type is selected. Unsupported CPU type is set for the CPU type of 
GT Simulator3. Change the CPU type and restart monitoring.

No response from GX Simulator for termination 
request.
GX Simulator is closed forcibly.
Exit GT Simulator3 immediately and shutdown the 
personal computer.

• MELSOFT application was closed incorrectly.
• Incorrect processing is activated.

Restart the personal computer and restart GT 
Simulator3.

An SFC program cannot be written to GX Simulator.
Specify a program other than the SFC program.

An SFC type GX Developer project is specified. Set the GX Developer project again in the [Option] 
dialog.

Project information of GX Developer cannot be 
acquired.
Gppw.gps or Gppw.gpj cannot be found.

An incorrect GX Developer project may be set. Set the GX Developer project again in the [Option] 
dialog.

An incorrect CPU type. Unsupported CPU type is specified in the GX 
Developer project. Change the CPU type of the GX Developer project.

GX Works2 is not installed properly.
Install GX Works2.

• GX Works2 (GX Simulator2) is not installed.
• GX Works2 (GX Simulator2) may not be installed 

properly.
Reinstall GX Works2 (GX Simulator2).

'GX Works3' is not properly installed.
Install 'GX Works3'. 

• GX Works3 (GX Simulator3) is not installed.
• GX Works3 (GX Simulator3) may not be installed 

properly.
Reinstall GX Works3 (GX Simulator3).

MT Developer2 is not installed properly.
Install MT Developer2.

• MT Developer2 (MT Simulator2) is not installed.
• MT Developer2 (MT Simulator2) may not be 

installed properly.
Reinstall MT Developer2 (MT Simulator2).

This version of GX Works2 is not supported.
Install GX Works2 with supported version.

The version of installed GX Works2 (GX 
Simulator2) is old.

Install version 1.03D or later of GX Works2 (GX 
Simulator2).

''GX Works3' of this version does not support the 
simulator function.
Please use 'GX Works3' of the version 1.007H or 
later.

The version of the installed GX Works3 (GX 
Simulator3) is old.

Install version 1.007H or later of GX Works3 (GX 
Simulator3).

This version of MT Developer2 is not supported.
Install MT Developer2 with supported version.

The version of the installed MT Developer2(MT 
Simulator2) is old.

Install version 1.70Y or later of MT Developer2 (MT 
Simulator2).

Failed to connect since GX Simulator2 is not 
started.
Start GX Simulator2 and retry.

The simulation function of GX Works2 (GX 
Simulator2) is not started.

Start the simulation function of GX Works2 (GX 
Simulator2) and retry the operation.

Failed to connect to GX Simulator2.
<ES:0x******>
********************

• An application was closed incorrectly.
• Incorrect processing is activated.

• Restart GT Simulator3 and GX Works2.
• Restart the personal computer and start GT 

Simulator3.

Failed to connect to GX Simulator2.
Workspace name: ********************
Project name: ********************
Check the project name of started GX Simulator2 
and the one set in GT Simulator3.

GX Simulator2 that is operating in the GX Works2 
project set with GT Simulator3 does not exist.

Check the GX Works2 project specification of GT 
Simulator3 and started GX Simulator2 project, then 
change the settings.

No response from GX Simulator2 for termination 
request.
GX Simulator2 is closed forcibly.
Exit GT Simulator3 immediately and shutdown the 
personal computer.

• An application was closed incorrectly.
• Incorrect processing is activated.

Exit GT Simulator3 and shutdown the personal 
computer.

Unable to connect to 'GT Simulator3' since 'GX 
Simulator3' is not running.
Activate 'GX Simulator3' and retry.

The simulation function of GX Works3 (GX 
Simulator3) is not started.

Start the simulation function of GX Works3 (GX 
Simulator3) and retry the operation.

Failed to connect with 'GX Simulator3'.
<ES:0x******>
********************

• An application was closed incorrectly.
• Incorrect processing is activated.

• Restart GT Simulator3 and GX Works3.
• Restart the personal computer and start GT 

Simulator3.

This project data cannot be opened with the 
security key registered in the PC.

• The personal computer does not have the security 
key that matches the one assigned to the project.

• The security key in the personal computer expires.

Import the valid security key using GT Designer3, 
and then start a simulation again.

Error message Details of error and cause Corrective action
3. SIMULATION
3.8 Troubleshooting
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3.8.2 Troubleshooting for saving files

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
Symptom Details of error and cause Corrective action

No files are output when the hard copy command is 
executed from the monitor screen of GT 
Simulator3.

The file cannot be saved due to problems with the 
output destination disk.

• Check that the folder specified as the virtual drive 
exists.

• Check the access privilege for the folder specified 
as the virtual drive.

• Check the disk space of the folder specified as the 
virtual drive.

The file cannot be saved since the file No. external 
control device value is not set within 1 to 9999.

Check that the file No. external control device value 
is set within 1 to 9999.
3 - 118 3. SIMULATION
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4.1 Data Transfer

➟4.1.1 Route for the data transfer
4.1.2 Types of the data to be transferred to the GOT

The data transfer function writes, reads, or verifies various data, such as package data, special data, and resource data, 
between the GOT and the personal computer (GT Designer3).

• Write
Package data or resource data is written or BootOS is installed to the GOT from the personal computer.

You can write package data from a personal computer to multiple GOTs on the same Ethernet network in one go.
This enables you to update the project in each GOT efficiently.
Since data is written to multiple GOTs simultaneously, the processing time becomes shorter.

• Read
Project data, package data, resource data, or drive information is read to the personal computer from the GOT.

• Verification
The running project data in GT Designer3 and the project data in the GOT are verified.
The data is verified based on the data or the modified date.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Write

GOTPersonal computer 
(GT Designer3)

Ethernet

Personal computer 
(GT Designer3)

Write

GOT

GOT GOT

Read

GOTPersonal computer 
(GT Designer3)

Verify

GOTPersonal computer 
(GT Designer3)
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Deleting unnecessary screen data or settings in the GOT
To delete unnecessary screen data or settings in the GOT, read the project data from the GOT, take either of 
the following actions, and write the project data to the GOT.
• Delete unnecessary screen data and settings in the project data.
• Select [Select] for [Write Mode] in the [Write Option] dialog and deselect unnecessary screen data or settings.
➟4.8.3 ■3 [Write Option] dialog
4. COMMUNICATING WITH GOT
4.1 Data Transfer
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4.1.1 Route for the data transfer

■1 Direct communication with the GOT and the personal computer (GT Designer3)

Data is transferred by the direct communication of the GOT and the personal computer.
The communication has the following routes.

(1) Communication using USB cable
The GOT and the personal computer are connected with a USB cable to communicate directly.

(2) Communication by Ethernet
The personal computer communicates directly with the GOT on the Ethernet network.

Using the wireless LAN communication unit allows wireless communication through a wireless LAN access point.

The following values are set for the Ethernet settings including the IP address and subnet mask of the GOT as default 
settings at shipment.

• Ethernet standard port 1: 192.168.3.18
• Subnet mask: 255.255.255.0

If a personal computer can access the network group set in the GOT by default, reading/writing data from/to the GOT 
with the factory settings is available by connecting the personal computer to the GOT.
Not available to GT21 and GS21.
If there are multiple GOTs whose factory settings remain unchanged, a connection to the GOTs is not available due to 
IP address duplication.
Set different IP addresses.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOTPersonal computer 
(GT Designer3)

USB cable

GOTPersonal computer 
(GT Designer3)

Ethernet

GOTPersonal computer
(GT Designer3)

Wireless LAN 
access point
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■2 Communication via a PLC

The personal computer communicates with the GOT via a PLC that is connected to the same Ethernet network, CC-Link 
IE TSN, or CC-Link IE Field Network as the GOT.
GT25-W, GT2505-V, GT25HS-V, and GS25 do not support the CC-Link IE Field Network connection.
GT23 does not support the CC-Link IE TSN and CC-Link IE Field Network connections.
The personal computer can communicate with the GOT over multiple networks through multiple PLCs as well.
Up to eight networks can be routed.
To communicate with the GOT over multiple networks, the routing parameters must be set for the routed PLCs.
For the details of PLCs and networks to be routed, refer to the following.

➟4.4 Transferring the Data between the Personal Computer and the GOT via PLC CPU
For the connecting method of the GOT and a PLC, refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1
• Example of communication via a PLC

• Example of communication via the network

The following shows the communication route via a PLC.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOTPersonal computer 
(GT Designer3)

PLC to be routed

Ethernet (Network No. 2)

Personal computer 
(GT Designer3)

Network to be routed

PLC to be routed GOT

GOT

Ethernet (Network No. 3)

MELSECNETNET/H or 
others (Network No. 1)

PLC to be routed
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(1) Connection using RS-232 cable
Connect the personal computer and a PLC with an RS-232 cable to communicate with the GOT via the PLC.

(2) Connection using USB cable
Connect the personal computer and a PLC with a USB cable to communicate with the GOT via the PLC.

(3) Connection using Ethernet cable
(a) Connecting directly to the Ethernet port

Connect the personal computer and a PLC with an Ethernet cable to communicate with the GOT via the PLC.

(b) Connecting by a hub
Connect the personal computer and a PLC with an Ethernet cable through a hub to communicate with the GOT via the 
PLC.

To connect a PLC and a hub, use an Ethernet interface module (RJ71EN71, QJ71E71 series, or LJ71E71 series).

GOTPersonal computer 
(GT Designer3)

Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

PLC

RS-232 cable

GOTPersonal computer 
(GT Designer3)

PLC

USB cable
Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

GOTPersonal computer 
(GT Designer3)

PLC

Ethernet cable
Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

Hub
(Ethernet)

GOT

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

Ethernet

PLCPLCPersonal computer 
(GT Designer3)

Network to be routedEthernet cable
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■3 Using the data storage

The package data, BootOS, or CoreOS is transferred by using the data storage such as a USB memory and SD card.

4.1.2 Types of the data to be transferred to the GOT

The following shows the types of data to be transferred between GT Designer3 and the GOT.

■1 Data to be written to the GOT

The following shows data to be written to the GOT.

For the size of each data and the storage destination in the GOT, refer to the following.
➟12.10 Data Transferred to the GOT and Storage Destination

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Write

Package data, 
BootOS, CoreOS

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Data Description Communication route

BootOS
For the BootOS, refer to the following.

➟1.2.1 BootOS, CoreOS and package data

• Direct connection using a USB cable

➟4.1.1 ■1 (1) Communication using USB 
cable

• Writing using the data storage

➟4.1.1 ■3 Using the data storage

CoreOS
For the CoreOS, refer to the following.

➟1.2.1 BootOS, CoreOS and package data

• Writing using the data storage

➟4.1.1 ■3 Using the data storage

Package data
For the package data, refer to the following.

➟1.2.1 BootOS, CoreOS and package data

The data is writable to the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

Resource data

Data to be used for GOT functions, including data collected by the 
recipe function and image files stored by the hard copy function
For the target resource data, refer to the following.

➟4.1.2 ■3 Transferable resource data
Files of 0 MB or more than 256 MB cannot be written to the GOT.

The data is writable to the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Data to be read from the GOT

The following shows data to be read from the GOT.

For the size of each data and the storage destination in the GOT, refer to the following.
➟12.10 Data Transferred to the GOT and Storage Destination

■3 Transferable resource data

The following shows the resource data that can be transferred between GT Designer3 and the GOT.
○: Available, ×: Not available

Data Description Communication route

Project data
For the project data, refer to the following.

➟1.2.2 Project

The data is readable from the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

Package data
For the package data, refer to the following.

➟1.2.1 BootOS, CoreOS and package data

The data is readable from the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

Resource data

Data to be used for GOT functions, including data collected by the 
recipe function and image files stored by the hard copy function
For the target resource data, refer to the following.

➟4.1.2 ■3 Transferable resource data

The data is readable from the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

Drive information Use status of each drive in the GOT
The data is readable from the GOT through any 
communication route.

➟4.1.1 Route for the data transfer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

File name*1 Write Read Description Supported 
models

AAMxxxxx.csv ○ ○
Alarm log file.
The file is used for the user alarm observation or the system alarm 
observation.

AAMxxxxx.txt ○ ○

AAMxxxxx.G2A × ○

ARPxxxxx.csv ○ ○

Recipe file.
The file is used for the recipe function.

ARPxxxxx.txt ○ ○

ARPxxxxx.G2P ○ ○

LOGxxx.csv ○ ○

Logging file.
The file is used for the logging function.

LOGxxx.txt ○ ○

LOGxxx.G2L × ○

OPELOGYYYYMMDD_xxxx.csv ○ ○ Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Operation log file.
The file is used for the operation log.

OPELOGYYYYMMDD_xxxx.txt ○ ○

OPELOGYYYYMMDD_xxxx.G2O × ○

SYSBK_YYMMDDHHMMSS.G2S ○ ○
Backup file of the data in the SRAM user area.
The file is used for the SRAM management.

#####.G2R ○ ○
Report file.
This file is used for the file print function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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#####.gpf2 ○ ○
Graphical waveform data file.
The file is used for the drive recorder.

#####.amo2 ○ ○
File of the data at the occurrence of an alarm.
The file is used for the drive recorder.

SNAPxxxx.bmp ○ ○
Image file.
The file is used for the parts display or the parts movement.

SNAPxxxx.jpg ○ ○

Image file.
The file is used for the parts display, the parts movement, or the 
document display.

#####.jpeg ○ ○

#####.png ○ ○
Image file.
The file is used for the parts display or the parts movement.

#####.gif ○ ○ Image file.

#####.3gp ○ ○

Video file.

#####.mp4 ○ ○

#####.mov ○ ○

#####.rm ○ ○

#####.divx ○ ○

#####.flv ○ ○

#####.f4v ○ ○

#####.pdf ○ ○ PDF file.

#####.wav ○ ○

Sound file.

#####.wma ○ ○

#####.mp3 ○ ○

#####.m4a ○ ○

#####.wmv ○ ○

#####.f4a ○ ○

#####.swf ○ ○ Flash file.

#####.ttf ○ ○

Font file.
#####.ttc ○ ○

File name*1 Write Read Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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*1 The file name is set by default.
The name can be changed by the user.
"xxxxx" indicates the serial number of a file.

#####.htm ○ ○

HTML file.
#####.html ○ ○

#####.xml ○ ○ XML file.

#####.xsl ○ ○ XSL file.

#####.chm ○ ○ Help file.

#####.js ○ ○ JavaScript file.

#####.css ○ ○ Cascading Style Sheet.

#####.doc ○ ○

Microsoft Word file.#####.docx ○ ○

#####.docm ○ ○

#####.xls ○ ○

Microsoft Excel file.#####.xlsx ○ ○

#####.xlsm ○ ○

#####.ppt ○ ○

Microsoft PowerPoint file.
#####.pptx ○ ○

#####.pptm ○ ○

#####.json ○ ○ JavaScript Object Notation.

File name*1 Write Read Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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4.2 Setting a System Application to be Written to the GOT

➟4.2.1 Specifications of the application setting
4.2.2 How to use the application setting

At the data transfer, GT Designer3 selects the required system application, communication driver, and special data 
automatically from the project setting and adds them to the package data.
However, the system application of the function which is not set in the project is not added to the package data.
Also, the user is required to add the writing data according to the function to use or the method of creating a project.
In the following cases, add the writing data using the application setting.

• When using the intelligent module monitor, the motion monitor, or the servo amplifier monitor
The special data (intelligent module monitor data, the motion monitor data, or the servo amplifier monitor data) are 
required to be added by the user.

• When using system applications (extended functions) for the sequence program monitors and others
You can configure and start the monitor functions, such as the sequence program monitors, in the utility without 
setting a special function switch or the GOT setup in the project.
However, unless you configure the functions in the project, necessary system applications are not incorporated into 
the package data.
Add necessary system applications to the package data in the application selection setting.
For the size of the system applications (extended functions) and the special data, refer to the following.

➟12.10.2 Transferred data size list

4.2.1 Specifications of the application setting

■1 Writing data the user can select
In the application setting, the following transfer data can be selected.

• System applications (extended functions) 
• Communication driver
• Special data

For the details of each data, refer to the following.
➟12.10 Data Transferred to the GOT and Storage Destination

■2 Method to hold the data when the project is saved
The transfer data which the user has selected manually are held in the project when the project is saved.
The method to hold the transfer data depends on the saving format.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Saving format of project data
Method to hold transfer data

User selected item System application, special data

A single file format project (GTXS, G2) The selected item is held. The data is saved to the package data with the 
project data.

A single file format project (GTX)
Workspace format project

The selected item is held. The data is not saved to the package data.
4. COMMUNICATING WITH GOT
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4.2.2 How to use the application setting

■1 Setting in the [Application Selection] dialog
The following shows an example of writing package data to GT27.

Step 1 Select [Common] → [Application Selection] from the menu.
Step 2 The [Application Selection] dialog appears.

Set the data to transfer to the GOT.
➟4.8.4 [Application Selection] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Setting when the data is written to the GOT
Step 1 Select [Communication] → [Write to GOT] from the menu.
Step 2 The [Communication Configuration] dialog appears.

Set the communication method with the GOT and click the [OK] button.
➟4.8.8 [Communication Configuration] dialog

Step 3 The [GOT Write] tab of the [Communicate with GOT] dialog appears.
Click the [Write Option] button.

➟4.8.2 ■1 [GOT Write] tab

Step 4 The [Write Option] dialog appears.
Click the [Application Selection] button.

➟4.8.3 [Write Option] dialog (for writing data to one GOT)

[Write Option] button
4. COMMUNICATING WITH GOT
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Step 5 The [Application Selection] dialog appears.
Set the data to transfer to the GOT.

➟4.8.4 [Application Selection] dialog

[Application Selection] button
4 - 14 4. COMMUNICATING WITH GOT
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4.3 Transferring the Data between the Personal Computer and the GOT

➟4.3.1 Connecting the personal computer to the GOT
4.3.2 Transferring data

Directly connect the personal computer and the GOT with a cable for the communication.
For the details of the data which can be transferred, refer to the following.

➟4.1.2 Types of the data to be transferred to the GOT

4.3.1 Connecting the personal computer to the GOT

➟■1 Connection using USB cable
■2 Connection using Ethernet cable
■3 Connection using Wireless LAN

A personal computer and GOT are connectable via USB, Ethernet, or wireless LAN.
To write package data to multiple GOTs in one go, connect a personal computer and the GOTs via Ethernet or wireless 
LAN.

➟■2 Connection using Ethernet cable
■3 Connection using Wireless LAN

The following shows each connection method.

■1 Connection using USB cable

(1) Connecting a personal computer to the GOT
Use the following cable to connect a personal computer to the GOT.

Step 1 Connect the A-type connector of a USB cable to the USB port of the personal computer, and the mini B type 
connector of the cable to the USB interface (Device) of the GOT.
For the location of the USB interface (Device) on the GOT, refer to the following.

➟GOT2000 Series User's Manual (Hardware)

Step 2 Power on the GOT.
Step 3 Only at the first connection, the USB driver is installed to the personal computer automatically.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Cable type Connector

USB cable A-mini B type

GOTPersonal computer 
(GT Designer3)

USB cable

A type connector mini B type connector
4. COMMUNICATING WITH GOT
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(2) Configuring the communication settings
Perform one of the following operations according to your purpose.

• To write data, select [Communication] → [Write to GOT] from the menu.
• To read data, select [Communication] → [Read from GOT] from the menu.
• To verify data, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
This dialog is displayable by selecting [Communication] → [Communication Configuration] from the menu as well.

➟4.8.8 ■1 Writing the data into the GOT directly
Configure the settings as shown below, and click the [OK] button.

Step 1 Select [Direct] for [Connection to GOT].
Step 2 Select [USB] for [PC side I/F].
Step 3 Set [Timeout (Sec)] and [Retry Times].
Step 4 Click the [OK] button to display the [Communicate with GOT] dialog.

For the operations of the [Communicate with GOT] dialog, refer to the following.
➟4.3.2 Transferring data

1.

2.

3.
4 - 16 4. COMMUNICATING WITH GOT
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■2 Connection using Ethernet cable

Not available to GT2105-Q.

(1) Connecting a personal computer to the GOT
To connect by Ethernet, connect the personal computer and the GOT to the same network.

Use the following Ethernet cables.

Step 1 Connect the Ethernet port of the personal computer and the Ethernet interface of the GOT using an Ethernet 
cable.
For the position of the Ethernet interface of the GOT, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
Step 2 Power on the GOT.

To transfer data to one GOT, set the communication method in the [Communication Configuration] dialog.
➟(2) Configuring the communication settings

To write package data to multiple GOTs in one go, perform the operation in the [Batch Write to multiple GOTs] dialog.
➟4.3.2 ■2 Writing package data to multiple GOTs in one go

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Cable type Description

Ethernet cable

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable (UTP): Category 3, 4, 
and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

GOTPersonal computer 
(GT Designer3)

Ethernet (Network No. 1)

GOT

Ethernet (Network No. 2)

GOT
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(2) Configuring the communication settings
Perform one of the following operations according to your purpose.

• To write data, select [Communication] → [Write to GOT] from the menu.
• To read data, select [Communication] → [Read from GOT] from the menu.
• To verify data, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
This dialog is displayable by selecting [Communication] → [Communication Configuration] from the menu as well.

➟■1 Writing the data into the GOT directly
Configure the settings as shown below, and click the [OK] button.

Step 1 Select [Direct] for [Connection to GOT].
Step 2 Select [Ethernet] for [PC side I/F].
Step 3 Set [GOT IP Address] and [Peripheral S/W Communication Port No.].
Step 4 Set [Timeout (Sec)] and [Retry Times].
Step 5 Click the [OK] button to display the [Communicate with GOT] dialog.

For the operations of the [Communicate with GOT] dialog, refer to the following.
➟4.3.2 Transferring data

1.

2.

4.

3.
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■3 Connection using Wireless LAN
Wireless LAN connection is available for use only in Japan.

(1) Connection using the GOT as a station
Set the GOT as a station to communicate with a personal computer via a wireless LAN access point.
To establish connection with the GOT, a wireless LAN access point (commercial product) is required.
For usable wireless LAN access points, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-
0160)

Before establishing connection, check the SSID, security authentication method, and WEP key or passphrase of the 
wireless LAN access point to be used.
For the check method, refer to the following.

➟Manual of the wireless LAN access point used

Step 1 Connect the personal computer and a wireless LAN access point on an Ethernet network.
For information on how to connect the wireless LAN access point, refer to the following.

➟Manual of the wireless LAN access point used
Step 2 Power on the GOT.
Step 3 Configure the following settings, and write the package data to the GOT.

• Wireless LAN setting ([GOT Setup])
➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

• IP address setting for the wireless LAN interface
➟5.4.1 ■3 (3) [Wireless LAN] tab

To transfer data to one GOT, set the communication method in the [Communication Configuration] dialog.
➟4.3.1 ■2 (2) Configuring the communication settings

To write package data to multiple GOTs in one go, perform the operation in the [Batch Write to multiple GOTs] dialog.
➟4.3.2 ■2 Writing package data to multiple GOTs in one go

(2) Connection using the GOT as a wireless LAN access point
Set the GOT as a wireless LAN access point to communicate with a personal computer.

Step 1 Power on the GOT.
Step 2 Configure the following settings, and write the package data to the GOT.

• Wireless LAN setting ([GOT Setup])
➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

• IP address setting for the wireless LAN interface
➟5.4.1 ■3 (3) [Wireless LAN] tab

To transfer data to one GOT, set the communication method in the [Communication Configuration] dialog.
➟4.3.1 ■2 (2) Configuring the communication settings

To write package data to multiple GOTs in one go, perform the operation in the [Batch Write to multiple GOTs] dialog.
➟4.3.2 ■2 Writing package data to multiple GOTs in one go

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOTPersonal computer
(GT Designer3)

Wireless LAN 
access point

GOTPersonal computer
(GT Designer3)
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4.3.2 Transferring data

➟■1 Writing data to one GOT
■2 Writing package data to multiple GOTs in one go
■3 Reading the data from the GOT
■4 Verifying projects between the GOT and GT Designer3

■1 Writing data to one GOT

For writing package data to multiple GOTs in one go, refer to the following.
➟■2 Writing package data to multiple GOTs in one go

The transfer data is written in the [Communicate with GOT] dialog.
For the procedure of displaying this dialog, refer to the following.

➟4.3.1 ■1 (2) Configuring the communication settings
4.3.1 ■2 (2) Configuring the communication settings

For the details of the settings, refer to the following.
➟4.8.2 ■1 [GOT Write] tab

(1) Writing the package data

Step 1 Select [Package Data] for [Write Data].
The capacity of the transfer data is displayed in [Data Size]. Check that the destination drive has the 
sufficient available space.
For the capacity and the storage destination of the data, refer to the following.

➟12.10 Data Transferred to the GOT and Storage Destination
Step 2 Select [Destination Drive].
Step 3 When the system application or the special data is required to be added to the package data or deleted, click 

the [Write Option] button and configure the setting in the [Write Option] dialog.

➟4.8.3 [Write Option] dialog (for writing data to one GOT)
Step 4 Click the [GOT Write] button.
Step 5 If data transfer security has been set for the target GOT, the dialog for entering the data transfer password 

is displayed.
Input the data transfer password.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1.

2.

3.

4.
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Step 6 The package data is written to the GOT.

(1) Execution of parameter verification (iQ Works only)
Before writing a project data to the GOT, execute [Verification of System Configuration Information and 
Parameters] by MELSOFT Navigator to check whether the system configuration diagram and the GT 
Designer3 controller setting are matched.
When the system configuration diagram does not match the GT Designer3 controller setting, the GOT may 
not monitor a controller correctly.
For MELSOFT Navigator operation, refer to the following.

➟Help for MELSOFT Navigator
(2) Precautions when selecting write data (iQ Works only)

When system labels are written and [System Label] is cleared for target data, system labels are deleted from 
a target project, and the labels are changed to devices.
The system labels changed to devices cannot be restored.
To hold the system label settings, do not clear [System Label] for the write target data.
When clearing [System Label] for the write target data, check the device setting.

(2) Writing the resource data

Step 1 Select [Resource Data] for [Write Data].
Step 2 Click the [Select Resource Data] button to display the [Select Resource Data] dialog.

➟4.8.5 [Select Resource Data] dialog

1.

2.
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Step 3 Click the [Add File] button in [PC] to display the [Open] dialog.

Step 4 Select a target file and click the [Open] button to display the file in the [Select Resource Data] dialog.

3.

4.

5.

6.

7.
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Step 5 Select the write destination drive of the GOT for [Drive] in [GOT].
Step 6 Click the [Get Drive Information] button to list the contents of the selected drive in the tree.
Step 7 In the tree, select a write destination folder and click the [OK] button to reflect the settings to the display of 

the [Communicate with GOT] dialog ([GOT Write] tab).
Check that the write destination drive has enough free space to store the target file according to the file size 
displayed in [Data Size].

Step 8 Click the [GOT Write] button in the [GOT Write] tab.
Upon completion of writing, the [Resource Data Write Result] dialog appears.
Check the write result.

➟4.8.6 [Resource Data Write Result] dialog

(3) Installing the BootOS
When the BootOS is installed, all the data in the GOT are deleted.
When the data in the GOT is required, read the data in advance.
Also, the BootOS can be installed only by the following method.

• Direct connection using a USB cable
• Data transfer using the data storage

When the personal computer and the GOT are connected by the method other than the direct connection using a USB 
cable, click the [Communication Configuration] button and change the setting, so that the direct connection using a USB 
cable is available.

8.
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Step 1 Select [BootOS] for [Write Data].
Step 2 Select [GOT Type] of the destination GOT for writing.
Step 3 Click the [GOT Write] button to install the BootOS to the GOT.

■2 Writing package data to multiple GOTs in one go

Not available to GT2105-Q.
In the [Batch Write to multiple GOTs] dialog, write package data to multiple GOTs in one go.
Select [Communication] → [Batch Write to multiple GOTs] from the menu to display the [Batch Write to multiple GOTs] 
dialog.
For the setting details, refer to the following.

➟4.8.9 [Batch Write to multiple GOTs] dialog
Connect a personal computer and multiple GOTs by Ethernet.
The package data cannot be written to the GOT whose type is different from the one set in the project of the package data.
The following settings cannot be written to multiple GOTs in one go.

• [GOT ID No.] in the [GOT Setup] window
➟5.3.2 ■4 [GOT ID No.]

• [I/F Communication Setting] dialog
➟5.7.3 [I/F Communication Setting] dialog

• [I/F] and [Driver] set for each channel in the [Controller Setting] window
➟5.5.1 ■4 [Controller Setting]

• [GOT Ethernet Setting] window
➟5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])

After writing package data to multiple GOTs in one go, if you verify the current project against the project stored in each 
GOT, inconsistencies in the above settings may be detected.
In the [Write Option] dialog, set whether to write the following settings to the target GOTs.

➟4.8.10 [Write Option] dialog (for writing data to multiple GOTs in one go)
• [Screen Switching/Windows] in the [Environmental Setting] window
• [System Information] in the [Environmental Setting] window
• [Station No. Switching] in the [Controller Setting] window
• [Connected Ethernet Controller Setting] in the [Controller Setting] window

1.
2.

3.

[Communication Configuration] button

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 1 Check the package data size with [Data Size], and make sure that the destination drive has enough free 
space for storing the data.

➟12.10 Data Transferred to the GOT and Storage Destination
Step 2 To add or delete a system application or special data to/from the package data, click the [Write Option] 

button to display the [Write Option] dialog and configure the setting.

➟4.8.3 [Write Option] dialog (for writing data to one GOT)
Step 3 Set [Destination Drive].
Step 4 Set [IP Address] and [Port No.] of target GOTs by one of the following methods.

• Automatic acquisition
Not available to GT21 and GS21.
Click the [Auto Acquisition] button to acquire the information of the GOTs on the same network.
The information existing in the list is deleted.

• Data entry
Enter [IP Address] and [Port No.].
You can copy data from a spreadsheet file or others as well.

• File import
Click the Import button to import the information of the GOTs.
A CSV file or Unicode text file can be imported.

Step 5 Select a checkbox in the [Target] column for the GOT to which the package data is written.
Step 6 If the data transfer security has been set for the project in the target GOT, enter the data transfer password.

➟4.7 Precautions
5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

Step 7 Click the [GOT Write] button.
The [Communication Status] dialog appears, starting the writing of the package data.

➟4.8.11 [Communication Status] dialog
After the writing is complete, check the result in the [Communication Status] dialog.

3.

6. 7.

2.1.

4.

5.
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■3 Reading the data from the GOT

The transfer data is read in the [Communicate with GOT] dialog.
For the procedure of displaying this dialog, refer to the following.

➟4.3.1 ■1 (2) Configuring the communication settings
4.3.1 ■2 (2) Configuring the communication settings

For the details of the setting procedure, refer to the following.
➟4.8.2 ■2 [GOT Read] tab

(1) Reading the project data or the package data

Step 1 Set [GOT Side] as follows.
• Select [Project Data] or [Package Data] for [Read Data].
• Select the drive where the project data or the package data is stored for [Source Drive].

Step 2 Set [PC Side].
Set the reading destination of the project for [Destination].
To read the project data to GT Designer3, select [GT Designer3].
(When [Read Data] is [Package Data], the project data cannot be read to GT Designer3.)
To read the project data as a file, click the [...] button to set the saving format and the saving destination of 
the file.

Step 3 Click the [GOT Read] button.
Step 4 If data transfer security has been set for the target GOT, the dialog for entering the data transfer password 

is displayed.
Input the data transfer password.

Step 5 The project is read.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2.

3.
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(2) Reading the resource data

Step 1 Set [GOT Side] as follows.
• Select [Resource Data] for [Read Data].
• Select the drive where the resource data is stored for [Source Drive].
• Set a resource file to be read for [Resource File]. 

Click the [...] button to set a resource file to be read in the [Path Specification] dialog.
Step 2 Set [PC Side].

Set the reading destination of the resource data for [Destination].
Click the [...] button to set the saving destination of the file to be read in the [Browse For Folder] dialog.

Step 3 Click the [GOT Read] button.
Step 4 If data transfer security has been set for the target GOT, the dialog for entering the data transfer password 

is displayed.
Input the data transfer password.

Step 5 The resource data is read.

1.

2.

3.
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(3) Reading the drive information

Step 1 Set [GOT Side] as follows.
• Select [Drive Information] for [Read Data].
• Select the read target drive for [Source Drive].

Step 2 Click the [Importing Drive Information] button.
Step 3 The folders in the specified drive appear in the tree.

1.
2.
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■4 Verifying projects between the GOT and GT Designer3

The project is verified in the [Communicate with GOT] dialog.
For the procedure of displaying this dialog, refer to the following.

➟4.3.1 ■2 (2) Configuring the communication settings
4.3.1 ■2 (2) Configuring the communication settings

For the details of the setting procedure, refer to the following.
➟4.8.2 ■3 [GOT Verification] tab

Step 1 Configure the setting as follows.
• Select the verification method in [Verification Method]. 

[Data Contents Check]: The descriptions of the data such as setting item are compared. 
[Time Stamp Check]: The time stamps of the files are compared.

• Select the drive where the project data is stored in [Target Drive].
Step 2 Click the [GOT Verification] button.
Step 3 If data transfer security has been set for the target GOT, the dialog for entering the data transfer password 

is displayed.
Input the data transfer password.

Step 4 The [Verify Result] dialog displays the verification results.

➟11.5.6 [Verify Result] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4.4 Transferring the Data between the Personal Computer and the GOT 
via PLC CPU

➟4.4.1 Connecting the personal computer and PLC CPU
4.4.2 Transferring data

The personal computer communicates with the GOT via a PLC that is connected to the same Ethernet network, CC-Link 
IE TSN, or CC-Link IE Field Network as the GOT.
GT25-W, GT2505-V, GT25HS-V, and GS25 do not support the CC-Link IE Field Network connection.
GT23 does not support the CC-Link IE TSN and CC-Link IE Field Network connections.
The personal computer can communicate with the GOT over multiple networks through multiple PLCs as well.
For the details of the data which can be transferred, refer to the following.

➟4.1.2 Types of the data to be transferred to the GOT
For the connecting method of the GOT and a PLC, refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1
• Example of communication via a PLC

• Example of communication via the network

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOTPersonal computer 
(GT Designer3)

Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

PLC to be routed

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

GOTPersonal computer 
(GT Designer3)

Network to be routed 
(MELSECNET/H or others)

PLC to be routed PLC to be routed

Ethernet
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■1 PLCs and networks to be routed
(1) Connection type between the GOT and a PLC

The following shows the applicable PLCs and the connection type between the GOT and the PLC.

○: Available, ×: Not available

Applicable PLC

Connection type between the GOT and a PLC

Ethernet connection
CC-Link IE TSN 

connection
CC-Link IE Field 

Network connectionPLC side: Ethernet 
module

PLC side: Built-in 
Ethernet port

RCPU

R00CPU, R01CPU, 
R02CPU ○ ○ *6 ○ ○

R04CPU, R08CPU, 
R16CPU, R32CPU, 
R120CPU

○ ○ *7 ○ ○

R08PCPU, R16PCPU, 
R32PCPU, R120PCPU ○ × × ○

R08SFCPU, R16SFCPU, 
R32SFCPU, R120SFCPU ○ × × ○

R04ENCPU, R08ENCPU, 
R16ENCPU, R32ENCPU, 
R120ENCPU

○ ○ *1*7 ○ ○

R12CCPU-V ○*2 × × ○

Motion CPU (MELSEC iQ-
R series) R16MTCPU, R32MTCPU ○ × × ○

Personal computer 
(GT Designer3)

Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

GOTPLC
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*1 Use port P1 of the network part. (The port must be enabled for Ethernet connection.)
*2 Use the Ethernet module in the multiple CPU system.
*3 For the conditions and settings to establish connection through the Ethernet port built in the QnUD(P)VCPU, refer to the 

following.

➟4.4.1 ■3 (3) Settings required for connection through the built-in Ethernet port of the QnUD(P)VCPU
*4 For Q12DCCPU-V (Basic mode), the serial number must start with 12042 or later.

For Q12DCCPU-V (Extended mode), the serial number must start with 15102 or later.
*5 Use a PLC CPU having a serial number stating with 13012 or later in the first 5 digits.

Use GT Works2 with version 1.50C or later.
*6 Use a PLC CPU with firmware version 08 or later.

QCPU

Q00JCPU, Q00CPU, 
Q01CPU, Q02CPU ○ × × ×

Q02HCPU, Q06HCPU, 
Q12HCPU, Q25HCPU ○ × × ×

Q02PHCPU, Q06PHCPU, 
Q12PHCPU, Q25PHCPU ○ × × ×

Q12PRHCPU (Main base 
unit), Q25PRHCPU (Main 
base unit), Q12PRHCPU 
(Remote extension base 
unit), Q25PRHCPU 
(Remote extension base 
unit),  Q12PRHCPU 
(Extension base unit), 
Q25PRHCPU (Extension 
base unit)

× × × ×

Q00UJCPU, 
Q00UJCPU-S8,
Q00UCPU, Q01UCPU,
Q02UCPU, Q03UDCPU, 
Q04UDHCPU, 
Q06UDHCPU, 
Q10UDHCPU, 
Q13UDHCPU, 
Q20UDHCPU, 
Q26UDHCPU

○ × × ○

Q03UDECPU, 
Q04UDEHCPU, 
Q06UDEHCPU, 
Q10UDEHCPU, 
Q13UDEHCPU, 
Q20UDEHCPU, 
Q26UDEHCPU, 
Q50UDEHCPU, 
Q100UDEHCPU

○ × × ○

Q03UDVCPU, 
Q04UDVCPU, 
Q06UDVCPU, 
Q13UDVCPU, 
Q26UDVCPU, 
Q04UDPVCPU, 
Q06UDPVCPU, 
Q13UDPVCPU, 
Q26UDPVCPU

○ ○*3 × ○

Q12DCCPU-V, 
Q24DHCCPU-V, 
Q24DHCCPU-LS, 
Q24DHCCPU-VG, 
Q26DHCCPU-LS

○ × × ○*4

LCPU

L02CPU, L06CPU, 
L26CPU-BT, L02CPU-P, 
L06CPU-P, L26CPU-P, 
L26CPU-PBT

○ × × ○*5

L02SCPU-P ○ × × ○*5

CC-Link IE Field Network 
remote head module

RJ72GF15-T2 × × × ○

LJ72GF15-T2 × × × ○

CC-Link IE Field Network 
Ethernet adapter module NZ2GF-ETB × × × ○

Applicable PLC

Connection type between the GOT and a PLC

Ethernet connection
CC-Link IE TSN 

connection
CC-Link IE Field 

Network connectionPLC side: Ethernet 
module

PLC side: Built-in 
Ethernet port
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*7 Use a PLC CPU with firmware version 40 or later.

(2) Connection type between the personal computer and a PLC
The following shows the applicable PLCs and the connection type between the personal computer and the PLC.

○: Available, ×: Not available

Available PLC
Connection type between the personal computer and a PLC

Connection using an 
Ethernet cable

Connection using a 
USB cable

Connection using an 
RS-232 cable

RCPU

R00CPU, R01CPU, R02CPU, R04CPU, 
R08CPU, R16CPU, R32CPU, R120CPU ○ ○ ×

R08PCPU, R16PCPU, R32PCPU, 
R120PCPU ○ ○ ×

R08SFCPU, R16SFCPU, R32SFCPU, 
R120SFCPU ○ ○ ×

R04ENCPU, R08ENCPU, R16ENCPU, 
R32ENCPU, R120ENCPU ○ ○ ×

R12CCPU-V ○ × ×

Motion CPU (MELSEC iQ-R 
series) R16MTCPU, R32MTCPU ○ ○ ×

QCPU

Q00JCPU, Q00CPU, Q01CPU, Q02CPU ○*1 × ○

Q02HCPU, Q06HCPU, Q12HCPU, 
Q25HCPU ○*1 ○ ○

Q02PHCPU, Q06PHCPU, Q12PHCPU, 
Q25PHCPU ○*1 ○ ○

Q12PRHCPU (Main base unit), 
Q25PRHCPU (Main base unit), 
Q12PRHCPU (Remote extension base unit), 
Q25PRHCPU (Remote extension base unit), 
Q12PRHCPU (Extension base unit), 
Q25PRHCPU (Extension base unit)

○*1 ○ ○

Q00UJCPU, Q00UJCPU-S8, Q00UCPU, 
Q01UCPU, Q02UCPU, Q03UDCPU, 
Q04UDHCPU, Q06UDHCPU, 
Q10UDHCPU, Q13UDHCPU, 
Q20UDHCPU, Q26UDHCPU

○*1 ○ ○

Q03UDECPU, Q04UDEHCPU, 
Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, 
Q26UDEHCPU, Q50UDEHCPU, 
Q100UDEHCPU

○ ○ ○*2

Q03UDVCPU, Q04UDVCPU, 
Q06UDVCPU, Q13UDVCPU, 
Q26UDVCPU, Q04UDPVCPU, 
Q06UDPVCPU, Q13UDPVCPU, 
Q26UDPVCPU

○ ○ ○*2

Q12DCCPU-V, Q24DHCCPU-V, 
Q24DHCCPU-LS, Q24DHCCPU-VG, 
Q26DHCCPU-LS

○ ○ ○*2

LCPU
L02CPU, L06CPU, L26CPU-BT, L02CPU-P, 
L06CPU-P, L26CPU-P, L26CPU-PBT ○ ○ ○*3

L02SCPU-P ○*1 ○ ○

CC-Link IE Field Network head 
module

RJ72GF15-T2 × ○ ×

LJ72GF15-T2 × ○ ×

Ethernet, CC-Link IE TSN, or CC-Link IE Field Network

Personal computer 
(GT Designer3)

GOTPLC
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*1 Since the CPU has no Ethernet port, it cannot be connected with an Ethernet cable.
Use an Ethernet module and a hub to connect the CPU.

*2 Connect the CPU via a QCPU in the multiple CPU system.
*3 An adapter (L6ADP-R2 or L6ADP-R4) is required.

(3) Network through which data can pass
The data can be transferred via the following network.

• MELSECNET/10
• MELSECNET/H
• CC-Link IE TSN
• CC-Link IE Controller Network
• CC-Link IE Field Network
• Ethernet

4.4.1 Connecting the personal computer and PLC CPU

➟■1 Connection using RS-232 cable
■2 Connection using USB cable
■3 Connection to the Ethernet port built in the PLC using an Ethernet cable
■4 Connection to the Ethernet port built in the PLC via a hub
■5 Connection to the Ethernet interface module via a hub

■1 Connection using RS-232 cable

(1) Connecting the personal computer and a PLC
Use the following cable to connect with a PLC.

For the PLCs connectable to the personal computer, refer to the following.
➟4.3.2 ■1 (2) Connection type between the personal computer and a PLC

Step 1 Check the connection type between the PLC to be routed and the GOT.
For the PLCs connectable to the GOT, refer to the following.

➟4.3.2 ■1 (1) Connection type between the GOT and a PLC
Step 2 Connect the RS232 ports of the personal computer and the PLC using an RS-232 cable.

For the position of the RS232 port of the PLC, refer to the following.
➟User's Manual of the PLC used

Step 3 Power on the PLC and the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC to be routed Cable type Cable model

QCPU
RS-232 cable GT01-C30R2-6P (3m)

LCPU

Personal computer 
(GT Designer3)

PLC

RS-232 cable

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

GOT
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(2) Configuring the communication settings
Perform one of the following operations according to your purpose.

• To write data, select [Communication] → [Write to GOT] from the menu.
• To read data, select [Communication] → [Read from GOT] from the menu.
• To verify data, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
This dialog is displayable by selecting [Communication] → [Communication Configuration] from the menu as well.

➟4.8.8 ■2 ■2 Writing the data via PLC CPU
Configure the settings as shown below, and click the [OK] button.

Step 1 Select [Via PLC] for [Connection to GOT].
Step 2 Set [Connection Image].

Select [RS232] for [PC side I/F].
Select the type of the PLC to be routed for [PLC side I/F].
Set [Timeout (Sec)] and [Retry Times].

Step 3 Set [Detail Setting].
Set the RS232 port and the transmission speed of the personal computer in [PC side I/F].
Set the network No. and the station number of the destination GOT in [GOT].

Step 4 Click the [OK] button to display the [Communicate with GOT] dialog.
For the operations of the [Communicate with GOT] dialog, refer to the following.

➟4.3.2 Transferring data

1.

2.
3.
4. COMMUNICATING WITH GOT
4.4 Transferring the Data between the Personal Computer and the GOT via PLC CPU

4 - 35



■2 Connection using USB cable

(1) Connecting the personal computer and a PLC
Use the following cable to connect with a PLC.

For the PLCs connectable to the personal computer, refer to the following.
➟4.3.2 ■1 (2) Connection type between the personal computer and a PLC

Step 1 Check the connection type between the PLC to be routed and the GOT.
For the PLCs connectable to the GOT, refer to the following.

➟4.3.2 ■1 (1) Connection type between the GOT and a PLC
Step 2 Connect the A type connector of a USB cable to the USB port of the personal computer and the B type 

connector or the mini B type connector to the USB port of the PLC.
For the position of the USB port of the PLC, refer to the following.

➟User's Manual of the PLC used

Step 3 Power on the PLC and the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC to be routed Cable type Connector

RCPU USB cable A-mini B type

QCPU

High Performance 
model QCPU USB cable A-B type

Universal model 
QCPU USB cable A-mini B type

LCPU USB cable A-mini B type

Personal computer 
(GT Designer3)

USB cable

A type connector
B type connector, 
mini B type connector

PLC

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

GOT
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(2) Configuring the communication settings
Perform one of the following operations according to your purpose.

• To write data, select [Communication] → [Write to GOT] from the menu.
• To read data, select [Communication] → [Read from GOT] from the menu.
• To verify data, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
This dialog is displayable by selecting [Communication] → [Communication Configuration] from the menu as well.

➟4.8.8 ■2 ■2 Writing the data via PLC CPU
Configure the settings as shown below, and click the [OK] button.

Step 1 Select [Via PLC] for [Connection to GOT].
Step 2 Set [Connection Image].

Select [USB] for [PC side I/F].
Select the type of the PLC to be routed for [PLC side I/F].
Set [Timeout (Sec)] and [Retry Times].

Step 3 Set [Detail Setting].
Set the network No. and the station number of the destination GOT in [GOT].

Step 4 Click the [OK] button to display the [Communicate with GOT] dialog.
For the operations of the [Communicate with GOT] dialog, refer to the following.

➟4.3.2 Transferring data

1.

2. 3.
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■3 Connection to the Ethernet port built in the PLC using an Ethernet cable

Use the following cable to connect the personal computer and the PLC.

For the PLCs connectable to the personal computer, refer to the following.
➟4.3.2 ■1 (2) Connection type between the personal computer and a PLC

To establish connection through the Ethernet port built in the QnUD(P)VCPU, configure the MELSOFT connection 
extended setting.

➟(3) Settings required for connection through the built-in Ethernet port of the QnUD(P)VCPU
To establish connection through the Ethernet port built in the RCPU, enable communication based on the network 
number and station number.

➟(4) Settings required for connection through the built-in Ethernet port of the RCPU

(1) Connecting the personal computer and a PLC
Step 1 Check the connection type between the PLC to be routed and the GOT.

For the PLCs connectable to the GOT, refer to the following.
➟4.3.2 ■1 (1) Connection type between the GOT and a PLC

Step 2 Connect the Ethernet port of the personal computer and the Ethernet port of the PLC to be routed using an 
Ethernet cable.
For the position of the Ethernet port of the PLC, refer to the following.

➟User's Manual of the PLC to be used

Step 3 Power on the PLC and the GOT.

Cable type Description

Ethernet cable

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable (UTP): Category 3, 4, 
and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer 
(GT Designer3)

PLC

Ethernet cable

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

GOT
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(2) Configuring the communication settings
Perform one of the following operations according to your purpose.

• To write data, select [Communication] → [Write to GOT] from the menu.
• To read data, select [Communication] → [Read from GOT] from the menu.
• To verify data, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
This dialog is displayable by selecting [Communication] → [Communication Configuration] from the menu as well.

➟4.8.8 ■2 ■2 Writing the data via PLC CPU
Configure the settings as shown below, and click the [OK] button.

Step 1 Select [Via PLC] for [Connection to GOT].
Step 2 Set [Connection Image].

Select [Ethernet] for [PC side I/F].
Select the type of the routed PLC ([RCPU], [QCPU], or [LCPU]) for [PLC side I/F].
Set [Timeout (Sec)] and [Retry Times].

Step 3 Set [PLC side I/F] in [Detail Setting].
Select [Connecting directly to the Ethernet port] for [Connection].

Step 4 Set [GOT] in [Detail Setting].
Set the network No. and the station number of the destination GOT.

Step 5 Click the [OK] button to display the [Communicate with GOT] dialog.
For the operations of the [Communicate with GOT] dialog, refer to the following.

➟4.3.2 Transferring data

1.

2.

3.

4.
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(3) Settings required for connection through the built-in Ethernet port of the QnUD(P)VCPU
Configure the settings on the PLC and GOT sides as shown below.

(4) Settings required for connection through the built-in Ethernet port of the RCPU
Configure the settings on the PLC and GOT sides as shown below.

Required setting Setting contents Requirements

PLC side setting

On GX Works2, configure the MELSOFT connection 
extended setting and write the parameter to the PLC.
For the MELSOFT connection extended setting, refer to 
the following.

➟QnUCPU User's Manual (Communication via Built-in 
Ethernet Port)

Use the QnUD(P)VCPU and GX Works2 that satisfy the 
following requirements.
• QnUD(P)VCPU: The serial number contains 17052 or 

later in the first 5 digits.
• GX Works2: Version 1.535H or later

GOT side setting

In GT Designer3, register the QnUD(P)VCPU in 
[Connected Ethernet Controller Setting] and write the 
package data to the GOT.
Set [Network No.], [Station No.], and [Port No.] as 
shown below.
• [Network No.]: [Network No.] set in the MELSOFT 

connection extended setting on GX Works2
• [Station No.]: [Station No.] set in the MELSOFT 

connection extended setting on GX Works2
• [Port No.]: 5001
For [Connected Ethernet Controller Setting], refer to the 
following.

➟5.5.1 ■4 [Controller Setting]

-

Required setting Setting contents Requirements

PLC side setting

In GX Works3, set [Communications by Network No./
Station No.] to [Enable], set the network number and 
station number, and then write the parameter to the 
PLC.
For [Communications by Network No./Station No.], refer 
to the following.

➟MELSEC iQ-R Ethernet User's Manual (Application)

For the firmware version of the applicable RCPU, refer to 
the following.

➟4.4■1 PLCs and networks to be routed

GOT side setting

In GT Designer3, register the RCPU in [Connected 
Ethernet Controller Setting] and write the package data 
to the GOT.
Set [Network No.], [Station No.], and [Port No.] as 
shown below.
• [Net No.]: [Network No.] set on GX Works3
• [Station No.]: [Station No.] set on GX Works3
• [Port No.]: 5001
For [Connected Ethernet Controller Setting], refer to the 
following.

➟5.5.1 ■4 [Controller Setting]

-
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■4 Connection to the Ethernet port built in the PLC via a hub

Use the following cable to connect the personal computer and the PLC.

For the PLCs connectable to the GOT, refer to the following.
➟4.3.2 ■1 (2) Connection type between the personal computer and a PLC

To establish connection through the Ethernet port built in the QnUD(P)VCPU, configure the MELSOFT connection 
extended setting.

➟4.4.1 ■3 (3) Settings required for connection through the built-in Ethernet port of the QnUD(P)VCPU
To establish connection through the Ethernet port built in the RCPU, enable communication based on the network 
number and station number.

➟4.4.1 ■3 (4) Settings required for connection through the built-in Ethernet port of the RCPU

(1) Connecting the personal computer and a PLC
Step 1 Use a hub to connect the personal computer and the PLC on the same Ethernet network.

Connect the hub and the Ethernet port of the PLC with an Ethernet cable.
For the position of the Ethernet port of the PLC, refer to the following.

➟User's Manual of the PLC or the Ethernet interface module to be used

Step 2 Power on the PLC and the GOT.

Cable type Description

Ethernet cable

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable (UTP): Category 3, 4, 
and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer 
(GT Designer3)

Hub 
(Ethernet)

PLC GOT

Network to be routed 
(MELSECNET/H or others)

PLC

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network
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(2) Configuring the communication method
According to the purpose, perform either of the following operations.

• For writing, select [Communication] → [Write to GOT] from the menu.
• For reading, select [Communication] → [Read from GOT] from the menu.
• For verifying, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
Select [Communication] → [Communication Configuration] from the menu to display this dialog.

➟4.8.8 ■2 (1) Connection using RS-232 cable and USB cable
Set the communication method as follows and click the [OK] button.

Step 1 Select [Via PLC] for [Connection to GOT].
Step 2 Set [Connection Image].

Select [Ethernet] for [PC side I/F].
Select the type of the routed PLC ([RCPU], [QCPU], or [LCPU]) for [PLC side I/F].
Set [Timeout (Sec)] and [Retry Times].

Step 3 Set [PC side I/F] in [Detail Setting].
Select the communication protocol to be used ([UDP] or [TCP]) in [Protocol].

Step 4 Set [PLC side I/F] in [Detail Setting].
Set [Connecting by the hub] for [Connection].
After selecting, set [IP Address] or [Host Name] of the PLC to be routed in [Destination].

Step 5 Set [GOT] in [Detail Setting].
Set the network No. and the station number of the destination GOT.

Step 6 Click the [OK] button to display the [Communicate with GOT] dialog.
For the operations of the [Communicate with GOT] dialog, refer to the following.

➟4.3.2 Transferring data

1.

2.

3.

4.

5.
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■5 Connection to the Ethernet interface module via a hub

Use the following cable to connect the personal computer and the PLC.

For the PLCs connectable to the GOT, refer to the following.
➟4.3.2 ■1 (2) Connection type between the personal computer and a PLC

(1) Connecting the personal computer and a PLC
Step 1 Use a hub to connect the personal computer and the PLC on the same Ethernet network.

Connect the hub and the Ethernet interface module with an Ethernet cable.

Step 2 Power on the PLC and the GOT.

Cable type Description

Ethernet cable

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable (UTP): Category 3, 4, 
and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet, CC-Link IE TSN, 
or CC-Link IE Field Network

Hub 
(Ethernet) Network to be routed 

(MELSECNET/H or others)

Personal computer 
(GT Designer3)

PLC PLC GOT
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(2) Configuring the communication method
According to the purpose, perform either of the following operations.

• For writing, select [Communication] → [Write to GOT] from the menu.
• For reading, select [Communication] → [Read from GOT] from the menu.
• For verifying, select [Communication] → [Verify GOT] from the menu.

The [Communication Configuration] dialog appears.
Select [Communication] → [Communication Configuration] from the menu to display this dialog.

➟4.8.8 ■2 (1) Connection using RS-232 cable and USB cable
Set the communication method as follows and click the [OK] button.

Step 1 Select [Via PLC] for [Connection to GOT].
Step 2 Set [Connection Image].

Select [Ethernet] for [PC side I/F].
Select the type of the Ethernet interface module to be routed ([RJ71EN71], [QJ71E71] or [LJ71E71]) for 
[PLC side I/F].
Set [Timeout (Sec)] and [Retry Times].

Step 3 Set [PC side I/F] in [Detail Setting].
Set [Network No.] and [Station No.].
Select the communication protocol to be used ([UDP] or [TCP]) in [Protocol].

Step 4 Set [PLC side I/F] in [Detail Setting].
Set [Station No.] of the PLC to be routed.
Set [IP Address] or [Host Name] of the PLC to be routed in [Destination].
Select the response method of the PLC in [Station No.<->IP information].

Step 5 Set [GOT] in [Detail Setting].
Set the network No. and the station number of the destination GOT.

Step 6 Click the [OK] button to display the [Communicate with GOT] dialog.
For the operations of the [Communicate with GOT] dialog, refer to the following.

➟4.3.2 Transferring data

1.

2.

3.

4.

5.
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4.4.2 Transferring data

To transfer data to the GOT via a PLC, use the same method as when the personal computer and the GOT are connected 
directly.
You cannot write package data to multiple GOTs in one go via a PLC.
For the transfer method, refer to the following.

➟4.3.2 Transferring data
However, the data transfer via a PLC differs in the following points.

• Transfer of the BootOS or the CoreOS
The BootOS and the CoreOS cannot be transferred by the data transfer via a PLC.
To install the BootOS to the GOT, connect the personal computer and the GOT using a USB cable or use the data 
storage.

➟4.3.1 ■1 Connection using USB cable
4.5.3 Installing the BootOS or the CoreOS to the GOT

To install the CoreOS to the GOT, use the data storage.
➟4.5.3 Installing the BootOS or the CoreOS to the GOT

• Remote password of the PLC to be routed
When the remote password is set for the PLC to be routed, the setting must be canceled at the communication with 
the GOT.
When the following dialog appears, input the remote password of the PLC to be routed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4.5 Transferring the Data with Data Storage

➟4.5.1 Writing a package data into the GOT
4.5.2 Starting up the package data from data storage
4.5.3 Installing the BootOS or the CoreOS to the GOT

Use the data storage such as SD card to transfer the data.
For the details of the data which can be transferred by this method, refer to the following.

➟4.1.2 Types of the data to be transferred to the GOT
For the available data storage, refer to the following Technical Bulletin.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas)(GOT-A-0160)
Operation Check Results of Non-Mitsubishi SD Cards on GOT2000 Series Units (GOT-A-0065)

4.5.1 Writing a package data into the GOT

Use the data storage to write the package data to the GOT.

Capacity check of the package data and the destination drive
Before writing the package data, check the data size of the package data to be transferred and the available 
space of the destination drive.
For how to check the available space of the destination drive, refer to the following.
➟GOT2000 Series User's Manual (Utility)

The following shows the procedure to write the package data.
Step 1 Connect the data storage to the personal computer.
Step 2 Open the project to be written in GT Designer3.
Step 3 Select [Communication] → [Write to Memory card] from the menu.

The [Transfer to Memory Card] dialog appears.
➟4.8.12 [Communicate with Memory Card] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Package data, 
BootOS, CoreOS

Write
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Package data Package data
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Step 4 Select the [Memory Card Write] tab.
Step 5 Set [PC Side].

The capacity of the transfer data is displayed in [Data Size]. Check that the destination drive has the 
sufficient available space.
When the system application or the special data is required to be added to the package data or deleted, click 
the [Write Option] button and configure the setting in the [Write Option] dialog.

➟4.8.3 [Write Option] dialog (for writing data to one GOT)
Step 6 Set [Memory Card].

Set the drive name of the data storage for [Destination Memory Card].
Select [Startup after installing data to specified drive] for [Startup Operation].
Select the write destination drive of the GOT for [Destination Drive].

Step 7 Click the [Memory Card Write] button.
Step 8 After the writing to the data storage is completed, remove the data storage from the personal computer.
Step 9 Install the data storage that has been removed from the personal computer to the GOT.

For how to install each data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

Step 10 Write the package data according to the GOT model.
• For GT27, GT25 (excluding GT2505-V), GT23, and GS25

While pressing the S.MODE switch, power on the GOT.
When the GOT is powered on, the package data is written to the GOT.

• For GT2505-V, GT21, and GS21
While touching the GOT screen lower-right corner, power on the GOT.
When the GOT is powered on, the package data is written to the GOT.

Step 11 After the writing of the package data is completed, touch the screen to restart the GOT.

5.

6.

7.

4.
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4.5.2 Starting up the package data from data storage

Start the GOT using the package data stored in the data storage.

Capacity check of the package data and the destination drive
Before writing the package data, check the data size of the package data to be transferred and the available 
space of the data storage.

Step 1 Connect the data storage to the personal computer.
Step 2 Open the project to be written in GT Designer3.
Step 3 Select [Communication] → [Write to Memory card] from the menu.

The [Transfer to Memory Card] dialog appears.
➟4.8.12 [Communicate with Memory Card] dialog

Step 4 Select the [Memory Card Write] tab.
Step 5 Set [PC Side].

The capacity of the transfer data is displayed in [Data Size]. Check that the data storage has the sufficient 
available space.
When the system application or the special data is required to be added to the package data or deleted, click 
the [Write Option] button and configure the setting in the [Write Option] dialog.

➟4.8.3 [Write Option] dialog (for writing data to one GOT)
Step 6 Set [Memory Card].

Set the drive name of the data storage for [Destination Memory Card].
Select [Direct startup from memory card] for [Startup Operation].

Step 7 Click the [Memory Card Write] button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Package data
Package data
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6.

7.

4.
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Step 8 After the writing to the data storage is completed, remove the data storage from the personal computer.
Step 9 Install the data storage that has been removed from the personal computer to the GOT.

For how to install each data storage, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

Step 10 Power on the GOT.

4.5.3 Installing the BootOS or the CoreOS to the GOT

Use the data storage to install the BootOS or the CoreOS to the GOT.
For the version of the BootOS or the CoreOS supported by each version of GT Designer3, refer to the following.

➟12.17 Upgraded Additional Function List

(1) Capacity check for the BootOS/CoreOS and the destination drive
Before installing the BootOS or the CoreOS, check the data size of the Boot OS or the CoreOS and the 
available space of the data storage.

(2) Data in the GOT
When the BootOS or the CoreOS is installed, all the data in the GOT are deleted.
When the data in the GOT is required, read the data in advance.

(3) Installing the CoreOS and the BootOS simultaneously
The BootOS is installed simultaneously at the installation of the CoreOS.
Reinstalling the BootOS is not required.

(4) Data storage for installing the CoreOS
The CoreOS is installed in drive A (standard SD card) only.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

BootOS, CoreOS BootOS, CoreOS
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■1 Writing the BootOS or the CoreOS to the data storage
Step 1 To install the BootOS, connect a data storage to the personal computer, and start GT Designer3.

To install the CoreOS, connect an SD card to the personal computer, and start GT Designer3.
Step 2 Select [Communication] → [Write to Memory card] from the menu.

The [Transfer to Memory Card] dialog appears.
➟4.8.12 [Communicate with Memory Card] dialog

Step 3 Select the [BootOS/CoreOS Write] tab.
Step 4 Set [PC Side].

Select the type of the destination GOT for [GOT Type].
The capacity of the transfer data is displayed in [Data Size]. Check that the data storage has the sufficient 
available space.

Step 5 Set [Memory Card].
Set the drive name of the data storage for [Destination Memory Card].

Step 6 Click the [Memory Card Write] button.
Step 7 After the writing to the data storage is completed, remove the data storage from the personal computer.
Step 8 Refer to the following to install the BootOS or the CoreOS to the GOT.

• Installing the BootOS
➟4.5.3 ■2 (1) Installing the BootOS

• Installing the CoreOS
➟4.5.3 ■2 (2) Installing the CoreOS

4.

5.
6.

3.

When [BootOS] is selected for [Write Data]

When [CoreOS] is selected for [Write Data]
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■2 Installing the BootOS or the CoreOS to the GOT from the data storage
(1) Installing the BootOS

Step 1 Install the data storage that has been removed from the personal computer to the GOT.
For how to install each data storage, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
Step 2 The procedure for installing the BootOS to the GOT depends on the GOT models.

• For GT27, GT25 (excluding GT2505-V), GT23, and GS25
While pressing the S.MODE switch, power on the GOT.
When the GOT is powered on, the BootOS is installed to the GOT.

• For GT2505-V, GT21, and GS21
While touching the GOT screen lower-right corner, power on the GOT.
When the GOT is powered on, the BootOS is installed to the GOT.

Step 3 After the installation of the BootOS is completed, power off the GOT.
Step 4 Remove the data storage from the GOT.
Step 5 Power on the GOT again.
Step 6 After powering on the GOT, write the required package data to the GOT.

(2) Installing the CoreOS
Step 1 Insert the SD card removed from the personal computer to the GOT.

For how to insert an SD card, refer to the following.
➟GOT2000 Series User's Manual (Hardware)

Step 2 Power on the GOT.
Step 3 The confirmation message for installing the CoreOS appears.

To install the CoreOS, touch the screen for two seconds or longer.
To abort the installation of the CoreOS, power off the GOT.

Step 4 When the installation of the CoreOS is completed, the completion message appears.
Touch the screen to restart the GOT.

Step 5 Write the required package data to the restarted GOT.
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4.6 Transferring Data between the Personal Computer and GT01-RS4-M

Directly connect the personal computer with GT01-RS4-M using a USB cable for communication.

■1 Transferring data between the personal computer and GT01-RS4-M
The following shows the data transfer procedure.
To transfer data, GT Designer3 (GOT1000) must be installed on the personal computer in advance.
For the details of the connection method and settings on GT Designer3 (GOT1000), refer to the following.

➟GT Designer3 Version1 Screen Design Manual (Fundamentals)

Step 1 Connect the personal computer with GT01-RS4-M using a USB cable.
Step 2 On GT Designer3 (GOT2000), select [Communication] → [Communicate with GT01-RS4-M] from the menu 

to start GT Designer3 (GOT1000) and display the [Communicate with GT01-RS4-M] dialog.

Perform the rest of the procedure on GT Designer3 (GOT1000).
➟GT Designer3 Version1 Screen Design Manual (Fundamentals)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4.7 Precautions

■1 Precautions for writing to the GOT
(1) Canceling writing the package data

When writing the package data is canceled during the process, the data in the GOT may be corrupt.
When writing the package data has been canceled during the process, write the package data again.

(2) Data in the GOT before the BootOS or the CoreOS is installed
When the BootOS or the CoreOS is installed, all the data in the GOT are deleted.
When the data in the GOT is required, read the data in advance.

(3) Precautions for the utilize data and the input assist information
When [Utilize data/Input assist information] is excluded from the package data at writing, the project read from the GOT 
operates as follows.

• The accumulated input assist information return to the initial status.
• The project data is not searched for when a new project is to be created using another project.

(4) Precautions for writing a project in the single file format (*.GTXS)
When the existing package data in the GOT contains the following setting, you cannot write even a later version of 
package data from GT designer3 whose version is earlier than 1.122C.
[Restrict write from GT Designer3 of the older versions] is selected in [GOT ID No.] in the GOT setup.
Install the latest version of GT Designer3, and then rewrite the package data.
For the settings of the GOT setup ([GOT ID No.]), refer to the following.

➟5.3.2 ■4 [GOT ID No.]

(5) Message at startup of the GOT that uses an earlier version of the BootOS
If the following message appears on the GOT that uses version S or earlier of the BootOS, update the BootOS to version 
T or later.
[The number of system applications installed exceeds the limitation. Please reduce the number of system applications to 
install.]

(6) Password for writing data to multiple GOTs in one go
In the [Batch Write to multiple GOTs] dialog, you can enter one data transfer password only.
If the entered password differs from the one set on a destination GOT, data cannot be written to the GOT.
In this case, enter the password which is set on the destination GOT and perform the writing again.

■2 Precautions for reading from the GOT
(1) Precautions for the utilize data

When the project data is saved to the personal computer directly at the reading from the GOT, the project data is not the 
target to search for the utilize data.
When the utilize data is used, open the project in GT Designer3 and save the project again after reading.

■3 Common precautions for reading and writing
(1) When the data storage stores a large number of folders or files

A large number of folders or files in the data storage may decrease file access performance, resulting in a much longer 
communication time than usual or a communication timeout.
Reduce the number of folders or files in the data storage as necessary.

(2) Precautions for the data transfer by Ethernet
(a) Advance preparation for the data transfer

For the data transfer by Ethernet, configure the following settings to the GOT in advance to enable the communication 
by Ethernet.

• Writing of the system application (basic function and communication driver)
• Communication settings

For how to check the setting, refer to the following.
➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Advance notification for the writing of the package data
When the package data is written by Ethernet, set a rule in advance, such as notifying the operator of the change of the 
package data.
When the package data is changed without a notice, the operation of the GOT may be affected.

(c) Securing a recovering method
Changing the communication settings when the project data is written may disable the communication with GT 
Designer3.
Save the data for recovering to the data storage or perform other methods, so that the GOT can recover.

(3) Power saving function of the personal computer
To transfer the data by connecting with the GOT, disable the power saving function of the personal computer and 
Windows.
For the details of the power saving function setting, refer to the manual of the personal computer or Windows Help.

(4) USB driver of other products
When the USB driver of other products is installed, the confirmation message for overwriting the USB driver file 
(windrvr6.sys) may appear.
If a new file already exists, click the [No] button and do not overwrite the file.
When the file is overwritten, the USB communication of GT Designer3 and the GOT may not be properly executed.

(5) Precautions for using a USB cable
To transfer the data by connecting the personal computer and the GOT using a USB cable, do not set the resume 
function, the suspending function, the power saving function, or the standby mode of the personal computer.
For the details of the resume function, the suspending function, the power saving function, or the standby mode, refer to 
the manual of the personal computer or the Help of Windows.
If the USB cable is removed or the GOT is reset or powered off/on, the communication may not be recovered from an 
error.
In this case, perform either of the following operations.

• Checking if the personal computer recognizes a USB
Check that [MITSUBISHI GOT2000 USB Controller] is displayed in [USB(Universal Serial Bus) Controller] in the 
device manager.

• Restart the GOT.
Remove the USB cable from the GOT and power off the GOT.
After the GOT is powered off, restart the GOT and connect a cable to communicate again.

Checking the file overwrite

Copy source: C:\...............\windrvr6.sys 
Copy destination: C:\.......................\windrvr6.sys

A file newer than the source file exists in the copy destination. 
Are you sure you want to overwrite the new file?

Yes (Y) No (N) Not all (A)
4 - 54 4. COMMUNICATING WITH GOT
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(6) Communication error when the PLC is not connected
If the GOT is not connected to a PLC with the connection setting to the PLC, the GOT fails to communicate with the PLC 
and retries the communication.
When the following operations are performed in GT Designer3 with this status, a communication error (error No. 
8011000a) may occur.

• Writing the package data
• Deleting the system application, the advanced application, the project data, and the resource data
• Drive format

For the corrective actions, refer to the following.
➟4.9 Troubleshooting

(7) Communication error by the firewall
The setting of the communication port of the personal computer may cause a communication error, such as timeout error.
When the port for the Ethernet communication is blocked by the firewall, a communication error occurs.
Disable the firewall or set the port to be opened.
For the details of the checking and the setting of the communication port, refer to the Help of Windows.

(8) Precautions for transferring data to the GOT via a PLC
For transferring data to the GOT via an RCPU and RJ71EN71, the GOT is connectable to Ethernet ports (P1 and P2) of 
the RJ71EN71.
If you set the same network number for both Ethernet ports (P1 and P2) of the RJ71EN71, connect the GOT to Ethernet 
port P1.
An error occurs if all the following conditions are satisfied.

• Both Ethernet ports (P1 and P2) of the RJ71EN71 are in use.
• The same network number is set for both Ethernet ports (P1 and P2).
• The GOT (data transfer destination) is connected to Ethernet port P2 of the RJ71EN71.

(9) Transferring data while firmware update is in progress
While firmware update of the communication unit mounted on the GOT is in progress, transferring data is not available.
To transfer data, make sure that firmware update is not executed.

(10)Transferring data while the FA transparent function is used
While the controller programming software communicates with a controller by using the FA transparent function, 
transferring data may not be available.
To transfer data, make sure that the FA transparent function is not in use.
4. COMMUNICATING WITH GOT
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4.8 Data Transfer Setting

➟4.8.1 [PC (Data Transfer)] dialog
4.8.2 [Communicate with GOT] dialog
4.8.3 [Write Option] dialog (for writing data to one GOT)
4.8.4 [Application Selection] dialog
4.8.5 [Select Resource Data] dialog
4.8.6 [Resource Data Write Result] dialog
4.8.7 [GOT Information - Detail] dialog
4.8.8 [Communication Configuration] dialog
4.8.9 [Batch Write to multiple GOTs] dialog
4.8.10 [Write Option] dialog (for writing data to multiple GOTs in one go)
4.8.11 [Communication Status] dialog
4.8.12 [Communicate with Memory Card] dialog

4.8.1 [PC (Data Transfer)] dialog

In the [PC (Data Transfer)] dialog, set the communication interface to be used for the data transfer between the personal 
computer and the GOT.
Select [Common] → [Peripheral Setting] → [PC (Data Transfer)] from the menu to display this dialog.

1) [Host (PC)]
Set the destination interface for the direct connection using a USB cable.

2) [Ethernet Download]
Set the destination interface for the connection by Ethernet.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Destination I/F]

Set the destination interface to be used for Ethernet download. The following shows the 
setting range.
• [Ethernet:Multi]

Connects to an Ethernet interface of the GOT.
• [Not connected]

Does not use an Ethernet interface of the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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4.8.2 [Communicate with GOT] dialog

In the [Communicate with GOT] dialog, the data is transferred and verified between the personal computer and the GOT.
This dialog can be displayed in the following method.

Step 1 According to the purpose, perform either of the following operations.
• For writing, select [Communication] → [Write to GOT] from the menu.
• For reading, select [Communication] → [Read from GOT] from the menu.
• For verifying, select [Communication] → [Verify GOT] from the menu.

Step 2 The [Communication Configuration] dialog appears.
Configure the communication setting between the personal computer and the GOT.

➟4.8.8 [Communication Configuration] dialog
Step 3 The [Communicate with GOT] dialog appears.

Click each tab to switch the display as required.

For the settings in each tab, refer to the following.
➟4.8.2 ■1 [GOT Write] tab
　 4.8.2 ■2 [GOT Read] tab
　 4.8.2 ■3 [GOT Verification] tab

■1 [GOT Write] tab

➟(1) Writing the package data
(2) Writing the resource data
(3) Installing the BootOS

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Writing the package data

1) [PC]
Set the data to be written to the GOT.

2) [GOT]
Set the destination to transfer the package data.

3) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
4) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

Item Description

[Write Data] Select [Package Data].

[Write Option] button
Set the details of the package data to be written to the GOT.
➟4.8.3 [Write Option] dialog (for writing data to one GOT)

[Data Size] Data size of the package data to be written to the GOT.

Item Description

[Destination Drive]

Select the destination drive to which the data is written.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] Type of the target GOT

[GOT Name] Name of the target GOT

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Destination Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.
➟4.8.7 [GOT Information - Detail] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)

3)

5)
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5) [GOT Write] button
Starts the data writing to the GOT.

(2) Writing the resource data

1) [PC]
Set the data to be written to the GOT.

2) [GOT]
Transfer destination for the resource data.
Configure the setting in the [Select Resource Data] dialog.

➟4.8.5 [Select Resource Data] dialog

3) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
4) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

Item Description

[Write Data] Select [Resource Data].

[Select Resource Data] button
Select the resource data to be written to the GOT.

➟4.8.5 [Select Resource Data] dialog

[Resource File] Resource data file to be written to the GOT

[Data Size] Size of the resource data file to be written to the GOT

Item Description

[Destination Drive] Write destination drive for the resource data

[Destination Folder] Write destination folder for the resource data

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] Type of the target GOT

[GOT Name] Name of the target GOT

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Destination Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.
➟4.8.7 [GOT Information - Detail] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)

3)

5)
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5) [GOT Write] button
Starts the data writing to the GOT.
Upon completion of writing, the [Resource Data Write Result] dialog appears.

➟4.8.6 [Resource Data Write Result] dialog

(3) Installing the BootOS

1) [Write Data]
Select [BootOS].

2) [GOT Type]
Type of the target GOT

3) [Version]
Version of the BootOS to be installed to the GOT.

4) [BootOS Size]
Data size of the BootOS to be installed to the GOT.

5) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
6) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

7) [GOT Write] button
Starts the data writing to the GOT.

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] Type of the target GOT

[GOT Name] Name of the target GOT

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Destination Drive]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

5)

7)

3)
4)

6)
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■2 [GOT Read] tab

(1) Reading the project data or the package data

1) [GOT]
Set the type of the data to be read from the GOT, and select the source drive.

2) [PC]
Set the destination of the project read from the GOT.

3) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Read Data]
Select [Project Data] or [Package Data].
When GT Designer3 is started from MELSOFT Navigator, [Package Data] cannot be 
selected.

[Source Drive]

Select the source drive from which the data is read.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

Item Description

[Destination]

Set the destination of the read project or package data.
When GT Designer3 is started from MELSOFT Navigator, the reading destination is fixed 
to [GT Designer3] if [Package Data] is selected for [Read Data].
• When [GT Designer3] is selected

The read project is opened in GT Designer3.
The project cannot be selected when the package data is read.

• When the path of the save destination folder is input
The project or the package data are read as a file in the specified folder.
Click the [...] button to display the [Save As Project] dialog.
The save destination folder and the saving format of the read project can be set in the 
displayed dialog.

1)

2)

4)

5)

3)
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4) [GOT Information]
The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

5) [GOT Read] button
Starts the data reading from the GOT.

(2) Reading the resource data

1) [GOT]
Set the type of the data to be read from the GOT, the read source drive, and the resource file name.

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] GOT type of the reading source GOT.

[GOT Name] Name of the reading source GOT.

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Source Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.
➟4.8.7 [GOT Information - Detail] dialog

Item Description

[Read Data] Select [Resource Data].

[Source Drive]

Select the source drive from which the data is read.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [D:Built-in SRAM] 
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

1)

2)

4)

5)

3)
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2) [PC]
Set the destination of the resource data read from the GOT.

3) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
4) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

5) [GOT Read] button
Starts the data reading from the GOT.

[Resource File]

Set the saving path and the file name of the resource data.
Click the [...] button to display the [Path Setting] dialog.
The read source drive and the resource file can be set by selecting the one in the displayed 
dialog.

• [Drive]
Select the read source drive.

• [Get Drive Information] button
Acquires the drive information of the read source drive.

• [Browse for resource file]
The file configuration of the read source drive is displayed in the tree.
The resource file to be read can be selected from the tree.

Item Description

[Destination]

Set the path for the destination of the resource data read from the GOT.
Click the [...] button to display the [Browse For Folder] dialog.
You can specify the destination folder to save the read resource data in the displayed 
dialog as well.

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] GOT type of the reading source GOT.

[GOT Name] Name of the reading source GOT.

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Source Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.

➟4.8.7 [GOT Information - Detail] dialog

Item Description
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(3) Reading the drive information

1) GOT-side setting
Set the type of the data to be read from the GOT, and select the source drive.

2) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
3) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

Item Description

[Read Data] Select [Drive Information].

[Source Drive]

Select the source drive from which the data is read.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [D:Built-in SRAM]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

[Get Drive Information] button Acquires the drive information of the drive selected in [Source Drive].

Drive information tree

The file configuration of the read source drive is displayed in the tree.
• [Delete] button

Collectively deletes folders and files selected in the tree.
Individually deleting the folder or file is not available.

• [Format] button
Formats the drive selected in [Source Drive].

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] GOT type of the reading source GOT.

[GOT Name] Name of the reading source GOT.

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Source Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.
➟4.8.7 [GOT Information - Detail] dialog

1)

3)

2)
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■3 [GOT Verification] tab

1) GOT-side setting
Specify the verification method and the GOT drive in which the project to be verified is stored.

2) [Communication Configuration] button
Displays the [Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
3) [GOT Information]

The information on the target GOT, including the GOT type and the capacity of the specified drive, is displayed.

4) [GOT Verification] button
Starts the verification with the GOT.

Item Description

[Verification Method]

Select the method to verify the project.
• [Data Contents Check]

The verification is performed according to the description of the project.
• [Time Stamp Check]

The verification is performed according to the time stamp of the project data.

[Target Drive]

Select the drive which stores the project data to be verified.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

Item Description

[Get GOT information] button Acquires the information from the target GOT, including the GOT type and the free space 
of the specified drive.

[GOT Type] Type of the target GOT

[GOT Name] Name of the target GOT

[Drive of package data in execution] Drive that stores the package data being used in the target GOT

[Free Space/Capacity] Free space and capacity of the drive selected for [Target Drive]

[Detail] button
Displays the [GOT Information - Detail] dialog.
➟4.8.7 [GOT Information - Detail] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4.8.3 [Write Option] dialog (for writing data to one GOT)

In the [Write Option] dialog, set the details of the package data to be written to one GOT.
The method for displaying the dialog differs depending on the writing destination.

■1 Displaying the dialog when writing data into the GOT
Display the dialog in the following method when writing data into the GOT.

Step 1 Select [Communication] → [Write to GOT] from the menu.
Step 2 The [Communication Configuration] dialog appears.

Configure the communication setting between the personal computer and the GOT.
➟4.8.8 [Communication Configuration] dialog

Step 3 The [Communicate with GOT] dialog appears.
Select [Package Data] for [Write Data] and click the [Write Option] button.

➟4.8.2 ■1 [GOT Write] tab

■2 Displaying the dialog when writing data into data storage
Display the dialog in the following method when writing data into data storage.

Step 1 Select [Communication] → [Write to Memory card] from the menu.
Step 2 The [Communicate with Memory Card] dialog appears.

Click the [Write Option] button.
➟4.8.12 ■1 [Memory Card Write] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Select [Package Data] and 
click the [Write Option] button.

Click the [Write Option] button.
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■3 [Write Option] dialog

1) [Package Data Information]

2) [Data Size]

3) [Initialize SRAM user area when writing project data/OS]
Not available to GT21 and GS21.
Initialize the SRAM user area when the package data is written to the GOT.

4) [Not restart automatically after writing (required to restart manually)]
The GOT does not restart automatically after the package data is written to the GOT.
When this item is selected, the GOT is required to be restarted manually after writing.

5) [Write Mode]
Select the write mode of the package data.

• [Synchronize]
Only the required data is written according to the difference with the package data which has already been 
written to the GOT.
The data which is not related to the package in the GOT is deleted.

• [Selection]
Only the data selected in the package data tree is written.

Item Description

[Project Title] Title of the project

[Project ID] ID number of the project

[Package Folder Name] Name of the folder that stores the package data

[GOT Type] GOT type of the project

[GOT IP Address]

[Ethernet Standard Port]
This item is not displayed for GT25-W and GS25.
GOT IP address set for the Ethernet standard port.

[Ethernet Standard Port1]
This item is displayed only for GT25-W and GS25.
GOT IP address set for Ethernet standard port 1.

[Ethernet Standard Port2] GOT IP address set for Ethernet standard port 2.

[Ethernet Extended Port] GOT IP address set for the Ethernet extended port.

[Wireless LAN] GOT IP address set for the wireless LAN interface.

[System Version] System application version in the package data

Item Description

[Project Data] Project data size (ROM and RAM)

[System Application] Size of the system applications included in the package data (ROM and RAM)

[Special Data] Size of the special data included in the package data (ROM and RAM)

[Buffering Area] Size of the buffering area in the operation memory (RAM)

7)

6)

5)

1)

3)
4)

2)
For GT25-W and GS25

For the models other than GT25-W and GS25
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The write mode is fixed to [Synchronize] in the following cases.
• The [Write Option] dialog is displayed from the [Communicate with Memory Card] dialog.
• Package data is written to the GOT without opening a single file format project (*.GTXS).
• System labels Ver.2, global labels, OMRON NJ/NX tags, or AB native tags are set in the common settings or 

object settings.
• The project contains a label group.
• The project is protected with a security key.
• The project contains a mobile screen.
• [Use GOT Mobile function] is selected in [Basic Setting] in the [GOT Mobile Setting] window.

6) Package data tree
The data included in the package data is displayed in the tree.
When [Selection] is selected for [Write Mode], the data can be added or deleted.

7) [Application Selection] button
This button is displayed only when [Synchronize] is selected for [Write Mode].
Clicking this button displays the [Application Selection] dialog.

➟4.8.4 [Application Selection] dialog
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4.8.4 [Application Selection] dialog

In the [Application Selection] dialog, system applications (extended functions), communication drivers, and special data 
are selectable, and the selected items are held in the project data.
Select [Common] → [Application Selection] from the menu to display this dialog.
Configure the settings by switching the tabs according to the target data.

➟■1 [System Application] tab
　 ■2 [Communication Driver] tab
　 ■3 [Special Data] tab

■1 [System Application] tab

1) [Extended Function] tree
Lists the system applications (Extended Function) which can be installed to the GOT in a tree view.
The application selected in the tree is written to the GOT regardless of whether to use or not use the function.
The application required for the GOT operation is displayed in light-blue.
The selection of the application displayed in light-blue cannot be canceled.

2) [Total size of system applications (Extended Function)]
Displays the total size of the system applications (Extended Function) selected in the tree.

3) [Total size of selected applications]
Displays the total size of all the items selected in the [System Application] tab, the [Communication driver] tab, and 
the [Special Data] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [Communication Driver] tab

1) [Communication driver] tree
Lists the system applications (Extended Function) which can be installed to the GOT in a tree view.
The communication driver selected in the tree is installed to the GOT regardless of whether to use or not use the 
function.
The communication driver required for the GOT operation is displayed in light-blue.
The selection of the communication driver displayed in light-blue cannot be canceled.

2) [Total size of system applications (Extended Function)]
Displays the total size of the system applications (Extended Function) selected in the tree.

3) [Total size of selected applications]
Displays the total size of all the items selected in the [System Application] tab, the [Communication driver] tab, and 
the [Special Data] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [Special Data] tab

1) [Language]
Select the language of the special data.

• [Japanese]
• [English]

2) [Special Data] tree
The list of the special data which can be written to the GOT is displayed in the tree.
The special data selected in the tree is written to the GOT regardless of whether to use or not use the function.

3) [Total size of special data]
The total size of the special data selected in the tree is displayed.

4) [Total size of selected applications]
Displays the total size of all the items selected in the [System Application] tab, the [Communication driver] tab, and 
the [Special Data] tab.
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4.8.5 [Select Resource Data] dialog

In the [Select Resource Data] dialog, set the resource data to be written to the GOT, and set the write destination.
To display this dialog, click the [Select Resource Data] button on the [GOT Write] tab in the [Communicate with GOT] dialog.

1) [Add File] button
Displays the [Open] dialog.
Select a resource data file to be written to the GOT.

2) [Delete] button
Deletes a selected resource data file from the write target list.

3) [Delete All] button
Deletes all resource data files from the write target list.

4) Write target list
Lists the resource data files to be written to the GOT.

5) [Drive]
Select the destination drive to which the resource data is written.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

6) [Get Drive Information] button
Reads the contents of a specified drive from the GOT.
The read data is displayed in the drive information tree.

7) [Folder Path]
Path to the write destination folder for the resource data
The path to the folder selected in the drive information tree is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8) [New Folder] button
Adds a new folder under the drive or folder selected in the drive information tree.
The new folder name is displayed in red.
The new folder is created upon completion of resource data writing.

9) [Delete] button
Deletes a newly-added folder that is selected in the drive information tree.

10) Drive information tree
Displays the folders and files in the drive that is selected for [Drive] in the tree view.
The folder selected in the tree is set as the write destination folder.

4.8.6 [Resource Data Write Result] dialog

The [Resource Data Write Result] dialog displays the result of resource data writing.
This dialog appears only after resource data writing is performed on the [GOT Write] tab in the [Communicate with GOT] 
dialog.

1) Write result list
Result of resource data writing

2) [Export] button
Displays the [Save As] dialog.
Save the write result to a file.

Item Description

[No.] File number

[File] Resource data file

[Status]
Write result
• [Succeeded]
• [Failed]
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4.8.7 [GOT Information - Detail] dialog

In the [GOT Information - Detail] dialog, data is written or read and the detailed information on the verification target GOT 
is displayed.

1) [GOT Type]
GOT type.

2) [GOT Name]
Name to identify the GOT.

3) [GOT ID]
ID number to identify the GOT

4) [GOT Description]
Detailed description for the GOT.

5) [Drive of package data in execution]
Drive that stores the package data being used in the GOT

6) [Drive]
Select the GOT drive whose detailed information is to be displayed.

7) [Get GOT information] button
Acquires the information from the GOT, including the GOT type and the free space of the specified drive.

8) [Storage Memory (ROM) Information]
Free space and capacity of the GOT storage memory (ROM)

9) [Operation Memory (RAM) Information]
Free space and capacity of the GOT operation memory (RAM)

10) [About ROM/RAM Information] button
Displays explanations of ROM and RAM in the GOT.

ROM and RAM in the GOT
The system applications and project data in the storage memory (ROM) are expanded to the operation memory 
(RAM) to run the GOT.
If the expanded data size exceeds the capacity of the operation memory (RAM), reduce the data size by deleting 
unnecessary project data or system applications, or other methods.
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4.8.8 [Communication Configuration] dialog

In the [Communication Configuration] dialog, the communication with the GOT is set.
Select [Communication] → [Communication Configuration] from the menu to display this dialog.
The settings differ according to the connection method of the personal computer and the GOT.
When the personal computer and the GOT are connected directly, select [Direct] for the [Connection to GOT].

➟■1 Writing the data into the GOT directly
When the personal computer and the GOT are connected via a PLC, select [Via PLC] for the [Connection to GOT].

➟■2 Writing the data via PLC CPU

■1 Writing the data into the GOT directly

1) [Connection to the GOT]
Select the connection method of the personal computer and the GOT.

• [GOT directly]
Connect the personal computer and the GOT directly using a cable.

• [Via PLC]
Connect the personal computer and the GOT via a PLC.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Connection to GOT]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
5)
6)
4. COMMUNICATING WITH GOT
4.8 Data Transfer Setting

4 - 75



2) [Connection Image]
Set the interface to be used or the device to be routed for the connection of the personal computer and the GOT.

3) [GOT]
Set the details of the interface of the GOT.
The details are set only when the GOT is connected by Ethernet.

4) [Communication Test] button
Performs the communication test of the personal computer and the GOT.

5) [Acquire GOT information and open the dialog]
Acquires the GOT identification information from a target GOT, and then displays the [Communicate with GOT] 
dialog or the [GOT Diagnostics] dialog.
For the details of the GOT identification information, refer to the following.

➟5.3.2 ■1 Specifications
6) [Display the dialog of [Communication Configuration] the next time as well]

Displays the [Communication Configuration] dialog before displaying the [Communicate with GOT] dialog or the 
[GOT Diagnostics] dialog.
If this item is deselected, the [Communication Configuration] dialog and this item do not appear from the next time.
To display the [Communication Configuration] dialog again, select [Display the dialog of Communication Setting 
before displaying the dialog of Communicate with GOT/GOT Diagnostics] in the [Operation] tab in the [Options] 
dialog.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)

Settings of [Timeout (Sec)] and [Retry Times]
After setting [Timeout (Sec)] and [Retry Times] in a project on GT Designer3 version 1.122C or later, if you open 
the project on GT Designer3 whose version is earlier than 1.122C, the setting items do not appear.
Upon the writing of the project, the GOT operates using the values of [Timeout (Sec)] and [Retry Times] set on 
GT Designer3 version 1.122C or later.

Item Description

[PC side I/F]
Select the type of the interface of the personal computer.
• [USB]
• [Ethernet]

[Timeout (Sec)]

Set the time period for the communication between the personal computer and the GOT to 
time out.
The setting range is [1] to [9999] seconds.
If you set a time less than 30 seconds, a communication error may occur.
Set 30 seconds or more.

[Retry Times] Set the number of retries to be performed when a communication error occurs. The setting 
range is [0] time to [5] times.

Item Description

[GOT IP Address] Set the IP address of the GOT. The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

[Peripheral S/W Communication Port No.] Set the port No. used for the communication with GT Designer3. The setting range is 
[1024] to [65534].

[Select from setting/list] Select the interface setting of the GOT from the GOT identification information registered 
in the project.

[List] button
Displays the [GOT Setting List] dialog. The interface setting of the GOT can be selected 
from the list.
➟5.3.2 ■5 [GOT Setting List] dialog
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■2 Writing the data via PLC CPU

(1) Connection using RS-232 cable and USB cable

1) [Connection to GOT]
Select the connection method of the personal computer and the GOT.

• [Direct]
Connect the personal computer and the GOT directly using a cable.

• [Via PLC]
Connect the personal computer and the GOT via a PLC.

2) [Connection Image]
Set the interface to be used or the device to be routed for the connection of the personal computer and the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[PC side I/F]

Select the type of the interface of the personal computer.
• [RS232]
• [USB]
• [Ethernet]

[PLC side I/F]

Select a PLC type to be routed.
• [RCPU] (This item is not selectable when [RS232] is selected for [PC side I/F].)
• [QCPU]
• [LCPU]

[Ethernet/CC-Link IE TSN/CC-Link IE Field] Network to be routed which the GOT is connected.

[Timeout (Sec)]

Set the time period for the communication between the personal computer and the GOT to 
time out.
The setting range is [1] to [9999] seconds.
If you set a time less than 30 seconds, a communication error may occur.
Set 30 seconds or more.

[Retry Times] Set the number of retries to be performed when a communication error occurs. The setting 
range is [0] time to [5] times.
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3) [PC side I/F]
Set the details of the interface of the personal computer.
The details are set only when the GOT is connected using RS-232 cable.

4) [GOT]
Set the details of the interface of the GOT.

5) [Test] button
Performs the communication test of the personal computer and the GOT.

6) [Acquire GOT information and open the dialog]
Acquires the GOT identification information from a target GOT, and then displays the [Communicate with GOT] 
dialog or the [GOT Diagnostics] dialog.
For the details of the GOT identification information, refer to the following.

➟5.3.2 ■1 Specifications
7) [Display the dialog of [Communication Configuration] the next time as well]

Displays the [Communication Configuration] dialog before displaying the [Communicate with GOT] dialog or the 
[GOT Diagnostics] dialog.
If this item is deselected, the [Communication Configuration] dialog and this item do not appear from the next time.
To display the [Communication Configuration] dialog again, select [Display the dialog of Communication Setting 
before displaying the dialog of Communicate with GOT/GOT Diagnostics] in the [Operation] tab in the [Options] 
dialog.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)

Item Description

[Communication port] Select the RS232 communication port of the personal computer. The setting range 
depends on the personal computer to be used.

[Baud Rate]

Select the transmission speed of the communication between the personal computer and 
the PLC.
• [115200] bps
• [57600] bps
• [38400] bps
• [19200] bps
• [9600] bps

Item Description

[Network No.] Set the network No. of the network to which the GOT is connected. The setting range is [1] 
to [239].

[Station No.] Set the GOT's station number. The setting range is [1] to [64].
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(2) Connecting by Ethernet

1) [Connection to the GOT]
Select the connection method of the personal computer and the GOT.

• [GOT directly]
Connect the personal computer and the GOT directly using a cable.

• [Via PLC]
Connect the personal computer and the GOT via a PLC.

2) [Connection Image]
Set the interface to be used or the device to be routed for the connection of the personal computer and the GOT.

Item Description

[PC side I/F]

Select the type of the interface of the personal computer.
• [RS232]
• [USB]
• [Ethernet]

[PLC side I/F]

Select the type of the PLC or the Ethernet interface module to be routed.
• [RCPU]
• [RJ71EN71]
• [QCPU]
• [QJ71E71]
• [LCPU]
• [LJ71E71]
To use port CPU P1 of the RnENCPU, select [RCPU]. To use port P1 of the RnENCPU, 
select [RJ71EN71]. (Port P2 does not support the Ethernet connection.)

[Ethernet/CC-Link IE TSN/CC-Link IE Field] Network to be routed which the GOT is connected.

[Timeout (Sec)]

Set the time period for the communication between the personal computer and the GOT to 
time out.
The setting range is [1] to [9999] seconds.
If you set a time less than 30 seconds, a communication error may occur.
Set 30 seconds or more.

[Retry Times] Set the number of retries to be performed when a communication error occurs. The setting 
range is [0] time to [5] times.

1)

2)

7)
8)
9)

5)

3)

4)

When connecting with a PLC

When connecting with the Ethernet interface module
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3) [PC side I/F]
Set the details of the interface of the personal computer.

4) [PLC side I/F] (when the destination is the PLC)
Configure the interface setting on the PLC side when the PLC (RCPU, QCPU, or LCPU) is connected.

5) [PLC side I/F] (when the destination is the Ethernet interface module)
Configure the interface setting on the PLC side when the Ethernet interface module (RJ71EN71, QJ71E71, or 
LJ71E71) is connected.

6) [GOT]
Set the details of the interface of the GOT.

Item Description

[Network No.]
Set the network No. of the Ethernet network to which the personal computer is connected. 
The setting range is [1] to [239]. The network No. is set only when the Ethernet interface 
module is connected.

[Station No.]

Set the station number of the personal computer.
To connect the personal computer with the Ethernet interface module, set the station 
number which does not overlap with other station numbers in the same network.
The following shows the setting range.
• When [PLC side I/F] is set to [QJ71E71] or [LJ71E71]: [1] to [64]
• When [PLC side I/F] is set to [RJ71EN71]: [1] to [120]

[Protocol]

Select the communication protocol to be used for the communication between the personal 
computer and the PLC.
• [TCP]
• [UDP]

Item Description

[Connection]
Select the connecting method of the personal computer and the PLC.
• [Connecting directly to the Ethernet port]
• [Connecting by the hub]

[Destination]

When [Connecting by the hub] is selected in [Connection], set the IP address or the host 
name of the destination PLC.
• [IP Address]

Specify the destination PLC by the IP address.
After selecting, set the IP address of the destination PLC.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

• [Host Name]
Specify the host name by the destination PLC.
Up to 64 characters can be set for the host name. A one-byte character is counted as one 
character, and a two-byte character is counted as two characters.

Item Description

[Network No.] Network No. of the Ethernet network to which the PLC is connected. The setting range is 
[1] to [239].

[Station No.]

Set the station number of the PLC.
The following shows the setting range.
• When [PLC side I/F] is set to [QJ71E71] or [LJ71E71]: [1] to [64]
• When [PLC side I/F] is set to [RJ71EN71]: [1] to [120]

[Destination]

When [Connecting by the hub] is selected in [Connection], set the IP address or the host 
name of the destination PLC.
• [IP Address]

Specify the destination PLC by the IP address.
After selecting, set the IP address of the destination PLC.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

• [Host Name]
Specify the host name by the destination PLC.
Up to 64 characters can be set for the host name. A one-byte character is counted as one 
character, and a two-byte character is counted as two characters.

[Station No.<->IP information]

When the PLC connected to the GOT communicates with a PLC of another station, select 
the method to acquire the network No., the station number, and the IP address of the PLC 
of another station. Select the item according to the network parameter of the destination 
PLC.
• [Automatic Response Method]
• [IP Address Calculation Method/Table Convert Method/Combination Method]

Item Description

[Network No.] Set the network No. of the network to which the GOT is connected. The setting range is [1] 
to [239].

[Station No.] Set the GOT's station number. The setting range is [1] to [64].
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7) [Communication Test] button
Performs the communication test of the personal computer and the GOT.

8) [Acquire GOT information and open the dialog]
Acquires the GOT identification information from a target GOT, and then displays the [Communicate with GOT] 
dialog or the [GOT Diagnostics] dialog.
For the details of the GOT identification information, refer to the following.

➟5.3.2 ■1 Specifications
9) [Display the dialog of [Communication Configuration] the next time as well]

Displays the [Communication Configuration] dialog before displaying the [Communicate with GOT] dialog or the 
[GOT Diagnostics] dialog.
If this item is deselected, the [Communication Configuration] dialog and this item do not appear from the next time.
To display the [Communication Configuration] dialog again, select [Display the dialog of Communication Setting 
before displaying the dialog of Communicate with GOT/GOT Diagnostics] in the [Operation] tab in the [Options] 
dialog.

➟11.10.3 ■1 [Option] dialog ([Operation] tab)
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4.8.9 [Batch Write to multiple GOTs] dialog

Not available to GT2105-Q.
In the [Batch Write to multiple GOTs] dialog, set the details of the data to be written, the write destination, and others.
To display this dialog, select [Communication] → [Batch Write to multiple GOTs] from the menu.

1) [PC]
View or set the details of the package data to be written to target GOTs.

2) [GOT]
View or set the details of the destination to which the package data is written.

Item Description

[Write Data] Type of the data to be written. ([Package Data])

[Data Size] Data size of the package data.

[Write Option] button
Displays the dialog to set the details of the package data.
➟4.8.3 [Write Option] dialog (for writing data to one GOT)

Item Description

[Destination Drive]

Set the drive to which the data is written.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

[Auto Acquisition] button Automatically acquires the GOT identification information, including the GOT IP address.

Delete All button Deletes all rows.

Import button

Imports the communication target setting, IP address, port number, and other GOT 
settings.
The following shows the available file formats.
• CSV format
• Unicode text format
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3) [Timeout (Sec)]
Set the timeout period for communication between the personal computer and each GOT.
The setting range is [1] second to [9999] seconds.
If you set a time less than 30 seconds, a communication error may occur.
Set 30 seconds or more.

4) [Retry Times]
Set the number of retries to be performed when a timeout occurs.
The setting range is [0] to [5].

5) [Test] button
Executes a communication test between the personal computer and each GOT.

6) [Apply] button
Confirms the new settings, and saves them in the current project.
This item is displayed only when this dialog has been brought up from the [Communication] menu.
The following shows the settings to be saved.

• [Destination Drive]
• [Skip unselected settings]
• [Target]
• [No.]
• [IP Address]
• [Port No.]
• [GOT ID]
• [GOT Name]
• [GOT Type]
• [I/F]
• [Timeout (Sec)]
• [Retry Times]

7) [GOT Write] button
Writes the data to the target GOT.

Export button

Exports the communication target setting, GOT settings, and communication result to a 
file.
The following shows the available file formats.
• CSV format
• Unicode text format

[Skip unselected settings] Only displays the rows marked with a checkmark in the [Target] column.

[Select All] button Selects all GOTs in the list as the communication target.

[Deselect All] button Deselects all the GOTs selected as the communication target.

[Target]
Select a target GOT.
This item is not settable for the GOT whose type is different from the one set in the project 
of the package data to be written.

[No.]
Number for each GOT in the list.
The number ranges from [1] to [256].

[IP Address]
Set the IP address of each GOT.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

[Port No.]
Set the port number of each GOT.
The setting range is [1024] to [65534].

[Status] Displays the communication result.

[Start Time] Displays the start time of a communication test or data write.

[End Time] Displays the end time of a communication test or data write.

[GOT ID] Displays the ID number to identify each GOT.

[GOT Name] Displays the name to identify each GOT.

[GOT Type] Displays the type of each GOT.

[I/F] Displays the interface type for each GOT IP address.

[Password for data transfer]
If the data transfer security has been set for the project in the target GOT, enter the data 
transfer password.

➟4.7 Precautions

Item Description
4. COMMUNICATING WITH GOT
4.8 Data Transfer Setting

4 - 83



4.8.10 [Write Option] dialog (for writing data to multiple GOTs in one go)

Not available to GT2105-Q.
In the [Write Option] dialog, set the details of the package data to be written to multiple GOTs in one go.
To display this dialog, click the [Write Option] button in the [Batch Write to multiple GOTs] dialog.

1) [Screen Switching/Window, System Information, Station No. Switching]
Set whether to write the following settings to the target GOTs.

• [Screen Switching/Windows] in the [Environmental Setting] window
• [System Information] in the [Environmental Setting] window
• [Station No. Switching] in the [Controller Setting] window

The following shows selectable items.
• [Write]
• [Not write]

If [Not write] is selected, the above settings in each target GOT will remain unchanged.
2) [[Controller Setting]-[Connected Ethernet Controller Setting] (each CH)]

Set whether to write the settings of [Connected Ethernet Controller Setting] in the [Controller Setting] window to the 
target GOTs.
The following shows selectable items.

• [Write]
• [Not write]

If [Not write] is selected, the above settings in each target GOT will remain unchanged.
3) [Initialize SRAM user area when writing project data/OS]

Not available to GT21 and GS21.
Initialize the SRAM user area when the package data is written to the GOT.

4) [Not restart automatically after writing (required to restart manually)]
The GOT does not restart automatically after the package data is written to the GOT.
When this item is selected, the GOT is required to be restarted manually after writing.

5) [Package Data Information]

Item Description

[Project Title] Title of the project

[Project ID] ID number of the project

[Package Folder Name] Name of the folder that stores the package data

[GOT Type] GOT type of the project

[System Version] System application version in the package data

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4.8.11 [Communication Status] dialog

Not available to GT2105-Q.
The [Communication Status] dialog displays the communication status or result of a simultaneous write or a 
communication test.
To display this dialog, click the [Test] button or the [GOT Write] button in the [Batch Write to multiple GOTs] dialog.

1) Communication status list
Lists the IP addresses and communication status of target GOTs.

2) [Show error details] button
Displays the details of an error in the GOT selected in the communication status list.

3) Progress bar
Shows the overall communication progress.

4) [Cancel] button
Cancels communication with the GOTs being in the waiting status.
The communication in progress cannot be canceled.
The data in the GOTs in the completion status cannot be reset to the state before the data write.

5) [Close] button
This item is displayed upon completion of communication.
Closes the [Communication Status] dialog, and updates [Start Time], [End Time], and [Status] in the [Batch Write 
to multiple GOTs] dialog.

Item Description

[No.] Displays the number for each GOT.

[IP Address] Displays the IP address of each GOT.

[Status] Displays the communication status or result.

[Data Size]

Displays the transferred data size and/or the total data size.
The data size is displayed according to [Status] shown below.
• Writing in progress: Transferred data size and total data size
• [Completed]: Total data size
• [Waiting]: -
• [Error]: -
For communication tests, the data size is not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Communication in progress

4)

2)

1)

3) 5)

Communication completed
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4.8.12 [Communicate with Memory Card] dialog

In the [Communicate with Memory Card] dialog, the information to be written to the data storage or the destination to write 
the data is set.
Select [Communication] → [Write to Memory Card] from the menu to display this dialog.
Configure the settings by switching the tabs according to the target data.

➟4.8.12 ■1 [Memory Card Write] tab
　 4.8.12 ■2 [BootOS/CoreOS Write] tab

■1 [Memory Card Write] tab

1) [PC Side]
The information related to the package data which is written to the data storage is displayed and set.

2) [Memory Card Side]
Set the information related to the destination data storage of the package data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Tab

Item Description

[Write Data] Type of the writing data. ([Package Data])

[Data Size] Data size of the package data.

[Writing Option] button
Set the details of the package data.
➟4.8.3 [Write Option] dialog (for writing data to one GOT)

Item Description

[Destination Memory Card]

Select the drive of the destination data storage.
The drive which is displayed in [Hard Disk Drive] or [Device with Removable Storage] of 
Windows can be used in [My Computer].
(The available drive depends on the personal computer.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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3) [Write Memory Card Information]
Information of destination data storage capacity.

4) [Memory Card Write] button
Writes the package data to the data storage.

■2 [BootOS/CoreOS Write] tab

1) [PC Side]
Set the information related to the BootOS or CoreOS to be stored in a data storage.

[Startup Operation]

Set the startup operation of the GOT of when the package data in the data storage is 
written to the GOT.
• [Startup after installing data to specified drive]
• [Direct startup from memory card]

[Destination Drive]

Set the destination drive of when the package data is written to the GOT.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

Item Description

Item Description

[Write Data]
Select the type of the writing data.
• [BootOS]
• [CoreOS]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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4)
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2) [Memory Card Side]
Set the information related to the data storage in which the BootOS or CoreOS is stored.

3) [Write Memory Card Information]
Information of destination data storage capacity.

4) [Memory Card Write] button
Writes the BootOS or the CoreOS to the data storage.

[GOT Type]

Select the GOT type for the BootOS or the CoreOS.
When [CoreOS] is selected for [Write Data], GT21 and GS21 models are not selectable.
• [GT27**-X(1024x768)]
• [GT27**-S(800x600)]
• [GT27**-V(640x480)]
• [GT2705-V(640x480)]
• [GT25**-WX(1280x800)]
• [GT25**-W(800x480)]
• [GT25**-S(800x600)]
• [GT25**-V(640x480)]
• [GT2505-V(640x480)]
• [GT23**-V(640x480)]
• [GT2107-W(800x480)]
• [GT2105-Q(320x240)]
• [GT2104-R(480x272)]
• [GT2104-P(384x128)]
• [GT2103-P(320x128)]
• [GS25**-WX(1280x800)]
• [GS21**-W-N(800x480)]
• [GS21**-W(800x480)]
For the correspondence between the GOT types and GOT models, refer to the following.

➟1.1.2 Supported models

[Version] Version of the BootOS or the CoreOS

[Data Size] Data size of the Boot OS or the CoreOS

Item Description

[Destination Memory Card]

Select the drive of the destination data storage.
The drive which is displayed in [Hard Disk Drive] or [Device with Removable Storage] of 
Windows can be used in [My Computer].
(The available drive depends on the personal computer.)

Item Description
4 - 88 4. COMMUNICATING WITH GOT
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4.9 Troubleshooting

When an error occurs during the data transfer, check the following items.
If an error occurs after the following actions are taken or an error which is not described in the following list occurs, consult 
a service representative.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error code Error message Description Corrective action

80100005
An error occurred.
The file in the p.c. cannot be written.

Failed to write to the file in the personal 
computer.

Check that the drive to which the file is 
written can be written or has enough 
available space in the disk capacity.

80110003
An error occurred.
Please check Port No..

The set port No. is out of the range. Check the port No.

80110004
An error occurred.
Time out error

Communication time error Check the communication cable and the 
power of the device.

80110006
An error occurred.
The GOT is being accessed by another 
application.

The GOT is being accessed by another 
application. Wait until another application ends.

80110007
An error occurred.
Quality of communication signal error.
Please check communication settings.

Error by the quality of the communication line Decrease the baud rate and perform the 
communication.

80110008
An error occurred.
Please check Baud rate.

The controller does not support the set baud 
rate.

Check the baud rate which the controller 
supports.

801fa303

An error occurred.
GOT restricts the communication with 
Ethernet.
Unable to communicate with GOT via 
Ethernet.

Communication via an Ethernet network is 
not allowed.

Disable the Ethernet Access Control 
(GS454) and the Processing Security 
Control via Wireless LAN (GS1840).

80112401

An error occurred.
Unable to communicate with GOT via 
Ethernet.
The possible causes are shown below.
(1) Basic system application is not written in 

the GOT
(2) The GOT is not turned on
(3) Communication Settings are not properly 

set
(4) GOT IP address is not properly set
(5) Incorrect wiring

The GOT does not exist on the network.

Check the followings.
• The basic system application is written to 

the GOT.
• The GOT is powered on.
• The communication settings are set 

correctly.
• [GOT IP Address] is set correctly in the 

[Communication Configuration] dialog.
• The wiring is correct.

80112402

An error occurred.
Unable to communicate with GOT via 
Ethernet.
The possible causes are shown below.
(1) The GOT is communicating with another 

computer
(2) GOT IP address is not properly set
(3) GOT Port No. is not properly set

Socket line open error
(Failed to generate a socket.)

Check the followings.
• The GOT is not communicating with 

another computer.
• The communication target is not the 

network device excluding the GOT.
• [Peripheral S/W Communication Port No.] 

in the [Communication Configuration] 
dialog matches with the port No. set to the 
GOT.

80112405

An error occurred.
Please check if both GOT and PC are 
properly connected together via Ethernet 
cabling.

Network error Check the GOT is connected to the network 
correctly.

80112406

An error occurred.
Unable to communicate with GOT via 
Ethernet.
The possible causes are shown below.
(1) The GOT is communicating via USB/

RS232
(2) The GOT is not turned on

The connecting socket is disconnected 
forcibly.

Check the followings.
• The GOT is not communicating using the 

USB or RS232.
• The GOT is powered on.

801fa000

An error occurred.
Routing parameter is insufficient in the GOT 
of the relay station.
Please set routing parameter for the GOT.

The routing parameter set for the relay 
station (GOT) is incorrect.

Check the routing parameter setting of the 
relay station.
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801fa080

An error occurred.
Information is insufficient in the GOT of the 
relay station Ethernet setting.
Please set the Ethernet setting of the GOT.

The Ethernet setting configured for the relay 
station (GOT) is incorrect.

Check the routing parameter and the IP 
address.

801fa200

An error occurred.
Communication driver is not booted in the 
GOT of the relay station.
Please check the GOT setting.

One of the following is the cause.
• No communication driver is installed on the 

GOT.
• The package data is corrupt.
• The communication driver does not support 

the relay function.

Install the package data on the GOT again.

801fa304

An error occurred.
The basic system application to be written is 
not valid for the H/W version of the GOT.
Please prepare the new drawing software.

The hardware versions of the BootOS and 
the GOT do not match.

Install the BootOS from the appropriate 
version of GT Designer3.

801fa305

An error occurred.
SD card cannot be accessed.
The possible causes are shown below.
• SD card cover of the GOT is open.
• SD card access switch of the GOT is turned 

off.

The possible causes are as follows.
• The SD card cover is open.
• The SD card access switch is turned off.

Close the SD card cover of the GOT.
Turn on the SD card access switch of the 
GOT.

801fa306

An error occurred.
Project data, system application, and 
resource data cannot be written/deleted 
since the write-protect switch is activated.
Please deactivate the write-protect switch.

The write protection switch of the data 
storage is on.

Cancel the write protection switch of the data 
storage.

801fa309

An error occurred.
The package data/resource data cannot be 
written due to the shortage of free space on 
the drive.

The available space of the drive is not 
sufficient.

Acquire the free space by deleting 
unnecessary files or others.
Or, reduce the size of the package data or 
resource data to be written.

801fa30c An error occurred.
The following drive is not mounted.
X: XXXXXXXXX
Check the drive.

The data storage is not connected to the 
specified drive.

Check the data storage is connected 
correctly to the specified drive.801fa30d

801fa311

An error occurred.
The specified file cannot be found.
Update the information.
(Click on the "Get Drive Information" button.)

The specified file does not exist. Check if the specified file name is correct.

801fa315
An error occurred.
The specified drive cannot be formatted.

The drive is used for the GOT direct startup 
and therefore cannot be formatted.

Select a drive that is not used for the GOT 
direct startup.

801fa317 An error occurred.
The cable is disconnected/unconnected or 
the GOT is in communication with another 
application.
The possible causes are shown below.
• GOT write is in process
• GOT read is in process
• GOT verification is in process
• GOT information acquisition is in process
• GOT diagnostics is in process

The possible causes are as follows.
• The communication cable is broken or 

disconnected.
• The GOT is in communication with another 

application.

• Check that the communication cable is 
connected correctly.

• Check that the GOT is not in 
communication with another application.

801fa318

801fa31f
An error occurred.
The password is wrong.

The input password is incorrect. Input the correct password.

801fa326

An error occurred.
The package data cannot be written due to 
the shortage of free space on the buffering 
area.

The free space in the buffering area is 
insufficient.

Reduce the size of the package data by 
decreasing the number of incorporated 
functions and others.

801fa327

An error occurred.
The package data cannot be written due to 
the shortage of free space on the project 
data area.

The free space in the project data area is 
insufficient.

Reduce the size of the package data by 
decreasing the number of incorporated 
functions and others.

801fa328

An error occurred.
The security key of the GOT is deleted.
Update the information.
(Click on the "Get GOT Information" button.)

The GOT is requested to delete a security 
key that has already been deleted.

Click the [Get GOT Information] button on 
the [GOT] tab in the [Security Key Setting] 
dialog to update the GOT information.

Error code Error message Description Corrective action
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801fa32a

An error occurred.
This function cannot be executed since the 
GOT does not support security key function.
The possible causes are shown below.
• Version of the BootOS in the GOT does not 

support security key function.

The following operations are performed to 
the GOT whose BootOS does not support 
the security key function.
• Writing a security key to the GOT
• Deleting a security key from the GOT
• Acquiring the GOT information

Install the latest version of GT Designer3 on 
the personal computer, and then install the 
latest BootOS on the GOT.

801fa32b

An error occurred.
The security key is set for the GOT.
Please delete the security key and then write 
again.

Writing of the security key is performed to the 
GOT that already has a security key.

Delete the current security key from the 
GOT, and then write a new one to the GOT.

801fa32f

An Error occurred
This function cannot be executed since the 
GOT does not support data write of the 
selected resource data.
The possible causes are shown below.
• The resource data that the destination GOT 

does not support is selected.
• Version of the basic system application in 

the GOT does not support data write of the 
selected resource data.

The write destination GOT does not support 
the file format of the selected resource data.
Or, the target GOT has an older version of 
the standard system application, and 
therefore the resource data file cannot be 
written.

Delete the unsupported resource data file 
from the write target list.
Or, install the latest version of GT Designer3, 
and then write the package data to the GOT.

801fa330

An Error occurred
Failed to access the file.
Perform the following operations.
• Reduce the number of files in the 

destination.
• Check if the selected file in the GOT exists.
• Check if the selected file in the GOT can be 

overwritten.

The number of files and folders has 
exceeded the storage limit for the root 
directory of the FAT16 formatted data 
storage on the write destination drive.

Reduce the number of the files and folders in 
the data storage on the write destination 
drive.

The selected file is nonexistent or write-
protected in the GOT.

Check the following.
• The selected file exists.
• The selected file is not write-protected.

801fa332

An Error occurred
Communication with the GOT is 
disconnected during monitoring.
Check the state of the GOT and retry.

Communication with the GOT has been lost 
due to a setting change in the utility or other 
causes.

Wait for some time, and then execute the 
GOT diagnostics again.

801fc202 An error occurred.
Please confirm whether a remote password 
is set in the relay station.
It is not possible to establish communication 
when a remote password is set in the relay 
station.

When the GOT accesses another station, 
the remote password authentication fails.

Do not set a remote password in the relay 
station and other stations, or exclude the 
GOT from the remote password 
authentication.801fc205

80110009

An error occurred.
Communication error
The possible causes are shown below.
• The communication port settings are 

incorrect.
• The cable is disconnected or broken.
• The GOT is turned off.
• The communication setting of each 

controller or routing parameter setting is 
incorrect.

• Dialog window is displayed in the GOT.
• Remote password is set for unsupported 

PLC/unit.
• It is not connected with GOT2000.
• The time set for "Timeout (Sec)" is short.

Packet send error Check the line is connected.

8011000a Communication time error Check the GOT operates normally and 
perform the communication again.

80112208 USB line error (Cable is disconnected 
halfway.) Check the USB cable connected to the GOT.

80112403 Socket line close error Perform the communication again.

80112501 Easysocket generate error

Check the followings.
• Easysocket is installed.
• The GOT is in communication process of 

another connection type.
• The GOT is connected correctly.

801fa302 The GOT is processing data and no interrupt 
is available.

After the GOT completes the current 
process, perform the operation again.

801fa307 The specified file is read-only. Check the destination data storage.

801fa30f The specified path does not exist. Check the specified path is correct.

801fa310 The specified path is incorrect.

Check the input path.
• The reserved word is not used.
• A dot is not used at the top.
• A dot is not used at the end.
• The path and the file name are not too long.

801fa32c
Writing data from GT Designer3 whose 
version is earlier than version 1.122C is 
restricted in the GOT.

Install the latest version of GT Designer3, 
and then perform the operation again.

801fa331
The GOT diagnostics cannot be executed 
due to IP address duplication, security key 
authentication failure, or other causes.

Check that the relevant settings are 
configured properly, and then execute the 
GOT diagnostics again.

Error code Error message Description Corrective action
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a

An error occurred.
The software installation file is damaged or 
incomplete.
Please reinstall.

Failed to generate the object of EZSocket. Reinstall GT Designer3.

c9
Memory Card error
Failed to create the folder.
Check if the destination memory card exists.

Folder creating error Check the destination data storage.

ca
Memory Card error
Failed to delete the folder.

Folder deleting error
Check either of the following operations.
• The specified folder exists.
• The specified folder is not read-only.

cc

Memory Card error
Failed to copy the file.
The capacity of the destination memory card 
is full.
Reduce the capacity.
*The specified drive may be write protected.

File copy error

Check the followings.
• Capacity of the data storage
• Access privilege of the destination drive
When the user account control is valid, set a 
destination drive other than drive C.

dc
Memory Card error
Failed to delete the file.

File deleting error
Check either of the following operations.
• The specified file exists.
• The specified file is not read-only.

132

An error occurred.
The BootOS cannot be written if its version is 
older than the one of the BootOS written in 
the GOT.
Version of the BootOS in the GOT: BB
Version of the BootOS to be written: AA

A later version of the BootOS is already 
installed on the GOT.

Install the BootOS version that is newer than 
the one installed to the GOT to the GOT.

133
An error occurred.
The GOT type is different or unsupported.

The GOT type acquired from the GOT and 
the one of the package data do not match.
Or, the type of the GOT to communicate with 
is not supported.

Check the GOT type of the project and the 
destination GOT.

134
An error occurred.
Package data is not written.
Write the package data.

The BootOS was started when the following 
processing is performed.
• Installing the BootOS
• Writing the package data
• Writing or acquiring the GOT identification 

information
• Performing the processing other than 

writing or acquiring of the security

Write the package data again.

13a

An error occurred.
Functions to be written and already written 
functions conflict with each other.
Selected function: %s
Written function: %s
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

Since the function which is written and the 
one which is already written are competing, 
the system application cannot be written.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

13d
(GT27, GT25, 
GT23, and GS25)

An error occurred.
There are more than 4 communication 
drivers that are already written in the GOT 
and those to be written.
(Up to 4 communication drivers can be 
written in GOT.)
Delete the already written communication 
drivers and write the items again.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

Four communication drivers have already 
been installed on the GOT.
Therefore, the communication driver cannot 
be installed.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

Error code Error message Description Corrective action
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13d
(GT21 and 
GS21)

An error occurred.
There are more than 2 communication 
drivers that are already written in the GOT 
and those to be written.
(Up to 2 communication drivers can be 
written in GOT.)
Delete the already written communication 
drivers and write the items again.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

Two communication drivers have already 
been installed on the GOT.
Therefore, the communication driver cannot 
be installed.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

190

An error occurred.
The package data in the memory card is 
directly started.
The following operations cannot be 
performed.
• Deleting directly-started package data
• Formatting the drive of package data in 

execution
• Writing another package data to the drive of 

package data in execution
• Writing package data to the destination 

other than the drive of package data in 
execution

*Take out the memory card from the GOT to 
perform these operations.

When the package data is started from the 
data storage directly, the following 
operations cannot be performed.
• Deleting the package data during the direct 

startup
• Formatting the startup drive
• Writing another package data to the startup 

drive
• Writing package data to a drive other than 

the startup drive

Do not perform the following operations.
• Deleting the package data during the direct 

startup
• Formatting the startup drive
• Writing another package data to the startup 

drive
• Writing package data to a drive other than 

the startup drive

191
An error occurred.
Failed to create the file.

Failed to create a file when the resource data 
is read. Check the destination folder is not read only.

192
An error occurred.
Failed to create the folder.

Failed to create a folder when the resource 
data is read. Check the destination folder is not read only.

193
An error occurred.
The processing is not properly completed 
since the data may be broken.

The data is broken.

The processing may recover if the 
processing is redone after GT Designer3 is 
installed again.
However, the processing cannot recover 
when the data in the saving file is broken.194

An error occurred.
The processing is not properly completed 
since the file may be broken.

195

An error occurred.
The package data to be written is insufficient.
Change the write mode to "Synchronize" and 
retry.

The basic system application is not included 
in the package data.

Add the basic system application and the 
project data in the package data.

196

An error occurred.
The system major version of the package 
data in the GOT is different from the one of 
the package data to be written.
The project data and special data will be 
deleted since they do not work properly if the 
major versions are different.
Package data without project data and basic 
system application cannot be written.

This error occurs when the package data is 
written without selecting the project data in 
the [Write Option] dialog, the same package 
data exists in the GOT, and the system 
application of the different major version is 
written.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

197

An error occurred.
Multiple package data are written in the 
drive.
In the current software, data cannot be 
written to the drive where multiple package 
data exist.
Please update the software version.

Multiple package data exist in the destination 
drive of the package data.

Write the package data from GT Designer3 
of the latest version or write the package 
data to other drives.

198
An error occurred.
There is no package data in the specified 
drive.

The package data does not exist in the 
specified drive.

Specify the drive in which the package data 
is stored.

199

An error occurred.
The package data cannot be written with the 
write mode "Select" since project security is 
set for the project.
Change the write mode to "Synchronize" and 
retry.

The package data with the project security is 
written to the GOT.
Therefore, the data cannot be written by 
setting [Write Mode] to [Selection] in the 
[Write Option] dialog.

Write the data by setting [Write Mode] to 
[Synchronize] in the [Write Option] dialog.

Error code Error message Description Corrective action
4. COMMUNICATING WITH GOT
4.9 Troubleshooting

4 - 93



19a
An error occurred.
Unsupported GOT security is set.
Please update the software version.

The GOT does not support the security 
setting to be written.

Install the latest version of GT Designer3, 
and then write the package data to the GOT.

19b

An error occurred.
Soft security key is set for the project in the 
GOT.
This function cannot be executed since the 
current GT Designer3 does not support the 
soft security key function.
Update the application and retry.

The project in the GOT is protected with a 
security key. Therefore, the following 
operations are not available.
• Verify GOT
• Read from GOT

Install the latest version of GT Designer3, 
and then perform the operation again.

19d

An error occurred.
It is necessary to update the BootOS written 
in the GOT to make the current package data 
work in the GOT.
Update the BootOS and write the package 
data again.
*Please check "Procedures and precautions 
for GOT Write" before updating the BootOS.

The package data containing the following 
items cannot be written to the GOT because 
the BootOS on the GOT does not support the 
items.
• [Wireless LAN]
• [MES Interface]
• [Printer(ESC/P-R)]
• [Network Drive]

Install the latest version of GT Designer3 on 
the personal computer, install the latest 
BootOS on the GOT, and then rewrite the 
package data to the GOT.

19e

An error occurred.
The write processing cannot be executed 
since the setting to restrict write from GT 
Designer3 of the older versions is in effect.
Check the version of GT Designer3 in which 
the editing is executed.

The setting, which restricts writing data from 
earlier versions of GT Designer3, is enabled 
on the GOT.
The GT Designer3 version is old.

Install the latest version of GT Designer3, 
and then perform the operation again.

1a0

An error occurred.
The package data cannot be written with the 
write mode "Select" since security key is set 
for the project.
Change the write mode to "Synchronize" and 
retry.

The package data to be written to the GOT 
contains a project protected with a security 
key.
Therefore, the data cannot be written when 
[Write Mode] is set to [Select] in the [Write 
Option] dialog.

Select [Synchronize] for [Write Mode] in the 
[Write Option] dialog.

1a1

An error occurred.
This function cannot be executed since the 
GOT does not support security key function.
The possible causes are shown below.
• Version of the basic system application in 

the GOT does not support security key 
function.

• Version of the BootOS in the GOT does not 
support security key function.

The following operations are performed to 
the GOT that does not support the security 
key function.
• Writing a security key to the GOT
• Deleting a security key from the GOT
• Acquiring the GOT information

Install the latest version of GT Designer3 on 
the personal computer, install the latest 
BootOS on the GOT, and then rewrite the 
package data to the GOT.

1a2

An error occurred.
This function cannot be executed since the 
GOT does not support GOT diagnostics 
function.
The possible cause is shown below.
• Version of the basic system application in 

the GOT does not support GOT 
diagnostics function.

The GOT diagnostics function that monitors 
occurring errors is not supported.

Install the latest version of GT Designer3, 
and then write the package data to the GOT.

1a5

An error occurred.
Functions to be written and already written 
functions conflict with each other.
Either GB2312 or GBK of Chinese 
(simplified) outline font can be written.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The system application cannot be written 
because the application conflicts with the 
existing one in the GOT.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

1a6

An error occurred.
FA transparent function is used in other 
MELSOFT applications for the GOT.
Terminate the function and retry.

Another MELSOFT application is using the 
FA transparent function, and therefore the 
following processes cannot be executed.
• Writing package data
• Installing the BootOS
• Deleting package data
• Formatting a drive
• Starting the GOT internal device monitor of 

the GOT diagnostics function

Wait 30 seconds after the application ends 
the FA transparent function, and then 
execute the process again.

Error code Error message Description Corrective action
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1a7

An error occurred.
Functions to be written and already written 
functions conflict with each other.
Either high-quality version (with antialiasing) 
or normal version (without antialiasing) of 
outline font can be written.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The system application cannot be written 
because the application conflicts with the 
existing one in the GOT.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

1a8

An Error occurred
This function cannot be executed since the 
GOT does not support resource file write.
The possible cause is shown below.
• Version of the basic system application in 

the GOT does not support resource file 
write.

The target GOT has an older version of the 
standard system application, and therefore 
the resource data file cannot be written.

Install the latest version of GT Designer3, 
and then write the package data to the GOT.

1a9

An Error occurred
The resource file that does not exist is 
specified.
Check the file to be written.

The selected resource data file is 
nonexistent. Check that the file exists.

1b0

An Error occurred
The resource file that cannot be read is 
specified.
Check the file to be written.

Another software application is using the 
selected resource data file, and therefore the 
file cannot be opened.

Check that the file is not being used by the 
other software applications.

1b1

An Error occurred
Memory capacity in the PC is insufficient.
Check the size of the resource file to be 
written.

The personal computer does not have 
enough memory, and therefore the selected 
resource data file cannot be opened.

Perform the following operations on the 
personal computer to free up the hard disk 
space and memory, and then write the 
resource data file.
• Exit unnecessary applications.
• Delete unnecessary files.

1b2

An error occurred.
There are more than 2 kanji regions of the 
outline font that is already written in the GOT 
and the outline font to be written.
(Up to 2 kanji regions can be written in 
GOT.)Delete the kanji regions of the already 
written outline font and write the font again.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The GOT has the outline font and two KANJI 
regions of data.
Therefore, different KANJI region data 
cannot be written additionally.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

1b3

An error occurred.
The style of the outline font that is already 
written in the GOT is different from the one of 
the outline font to be written.
(Only 1 style can be written in GOT.)
Delete the style of the already written outline 
font and write the font again.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The typeface data of the outline font to be 
written differs from the one in the GOT.
Therefore, the typeface data cannot be 
written.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

1b4

An Error occurred
The following function to be written conflicts 
with the function that is already written in the 
GOT.
• Key Window Design Information
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

Since the function which is written and the 
one which is already written are competing, 
the system application cannot be written.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

Error code Error message Description Corrective action
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1b5

An error occurred.
The package data cannot be written since 
the communication via Ethernet will be 
disabled if it is written in the following cases.
Write the package data from 
[Communication] -> [Write to GOT].
• Package data does not exist in the 

destination
• The package folder is different from the one 

of the package data in the destination drive
• The project ID is different from the one of 

the package data in the destination drive
• The major version of the package data in 

the destination drive is different from the 
one of the system application

• Security key is set for the write target 
package data

• Security key is set for the package data in 
the destination

• Free space of the destination drive is 
insufficient

As the individual identification information 
and the communication interface setting data 
are not written to multiple GOTs in one go, 
the following result will occur under the 
conditions shown left.
Ethernet communications become 
unavailable and the package data cannot be 
written accordingly.

Write the package data to each GOT 
individually by selecting [Communication] → 
[Write to GOT] or [Write to Memory Card] 
from the menu.

1b6

An error occurred.
The package data cannot be written since 
the data in the GOT contains the following 
settings.
• System Label Ver.2
• Global Label
• Label (GT Designer3)
• OMRON NJ/NX Tag
• AB Native Tag
*Change the setting of "Screen Switching/
Windows, System Information, Station No. 
Switching" to "Write" in the dialog of Write 
Option, and then write the package data.

When [Not write] is selected for [Screen 
Switching/Window, System Information, 
Station No. Switching] in the [Write Option] 
dialog, you cannot write package data to 
multiple GOTs in one go if any of the GOTs 
has the setting of labels or tags.

Perform one of the following operations.
• Select [Write] for [Screen Switching/

Window, System Information, Station No. 
Switching] in the [Write Option] dialog, and 
then rewrite the package data.

• Select [Communication] → [Write to GOT] 
or [Write to Memory Card] from the menu 
to write the package data to the target 
GOTs separately.

1b8

An error occurred.
Functions to be written and already written 
functions conflict with each other.
Either GOT Graphic Ver.1 or GOT Graphic 
Ver.2 of PC Remote Operation (Ethernet) 
can be written.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The system application cannot be written 
because the application conflicts with the 
existing one in the GOT.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

1b9

An error occurred.
The data cannot be written with the write 
mode "Select" since the package data that 
contains expanded base screens is written.
Change the write mode to "Synchronize" and 
retry.

The package data to be written to the GOT 
contains the project in which the base screen 
size expansion is enabled.
Therefore, the data cannot be written when 
[Write Mode] is set to [Select] in the [Write 
Option] dialog.

Select [Synchronize] for [Write Mode] in the 
[Write Option] dialog, and then write the 
package data.

Error code Error message Description Corrective action
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1bb

An error occurred.
The data cannot be written since the 
operation memory (RAM) size of the write 
data exceeds 128 MB, the capacity of the 
GOT.
Write data to the following GOT whose 
operation memory (RAM) capacity is 256 
MB.
• Function version on the rating plate on the 

GOT rear face: "C" or later
• Version of the basic system application: 

"01.39.000" or later
Check the following data sizes and write the 
package data again when writing the data to 
the GOT other than the above.
• Package data to be written
• CSP+ for iQSS data in the GOT

The RAM capacity required for the package 
data to be written to and the size of the iQSS 
data (CSP+) used in the GOT exceed the 
capacity of the GOT operation memory 
(RAM). Therefore, the data cannot be written 
to the GOT.

Write the package data after performing 
either of the following operations.
• Reduce the RAM capacity required for the 

package data.
• Write the data to a GOT with function 

version C or later and standard system 
application version 01.39.000 or later.

• Reduce the number of devices set for the 
iQSS data (CSP+) in the GOT and rewrite 
the data.

1bc

The RAM capacity required for the package 
data to be written to and the size of the iQSS 
data (CSP+) used in the GOT exceed the 
capacity of the GOT operation memory 
(RAM). Therefore, the data cannot be written 
to the GOT.
(The function version is earlier than C, or the 
standard system application version is 
earlier than 01.39.000.)

Write the package data after performing 
either of the following operations.
• Reduce the RAM capacity required for the 

package data.
• Write the data to a GOT with function 

version C or later and standard system 
application version 01.39.000 or later.

• Reduce the number of devices set for the 
iQSS data (CSP+) in the GOT and rewrite 
the data.

When the data is written to a GOT with 
function version C or later, update the 
standard system application according to 
one of the following procedures.
• Select [Select] for [Write Mode] and write 

the standard system application.
• Obtain the drive information on the [GOT 

Read] screen, delete the package data in 
the GOT, and rewrite the package data.

• While pressing the S.MODE switch on the 
GOT rear face, turn on the GOT and write 
the package data.

1bd

An error occurred.
Functions to be written and already written 
functions conflict with each other.
Either Kana-kanji Conversion or Pinyin 
Conversion can be written depending on the 
conversion method.
*Select "Synchronize" for Write Mode in the 
dialog of Write Option or delete the package 
data from the drive information in the [GOT 
Read] tab, and then write the package data.

The system application cannot be written 
because the application conflicts with the 
existing one in the GOT.

Write the package data after performing 
either of the following operations.
• Selecting [Synchronize] in [Write Mode] of 

[Write Option]
• Deleting the package data in [Drive 

Information] of [GOT Read]

Error code Error message Description Corrective action
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5.1 Changing the GOT Type of the Project ([GOT Type Setting])

➟5.1.1 Specifications of the GOT type change
5.1.2 Graphics mode ([Graphics Setting])
5.1.3 Base screen size expansion ([Expand base screen sizes])
5.1.4 Precautions
5.1.5 [Type Setting] dialog
5.1.6 [Output] window

The available functions depend on the GOT model.
Thus, set the GOT type of the project according to the GOT model.

5.1.1 Specifications of the GOT type change

If you change the GOT type in the [Type Setting] dialog, some settings may be deleted or changed, or the shape and 
shape frame settings may be changed.

■1 Setting to be held when the GOT type is changed
The setting of the changed GOT that is available in the newly set GOT is held after the GOT type change.

(1) Screen size
When the GOT type is changed to one with the same screen resolution, the screens are not resized.
The figures and objects on the screens are also not resized.

(2) Channel No. setting
When the GOT type after the change has the same channel No. and interface as those of the GOT type before the 
change, the channel No. is assigned to the same interface before the change.

(3) Library
The user-created library is not changed.
The parts and templates in the library can be used in the newly set GOT.
However, the library data containing figures or objects incompatible with the new GOT is not displayed on the library 
image list.

■2 Setting to be deleted when the GOT type is changed
Functions, settings, or screens that the newly set GOT does not have are deleted.

■3 Setting to be changed when the GOT type is changed
If the originally-selected GOT does not support some settings of the newly-selected GOT, the default values are applied 
according to the other related settings of the newly-selected GOT.
For some of the unsupported settings, the default values may not be applied depending on the combination of the 
originally-selected GOT and the newly-selected GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT2710-V

GT2712-S

Package data 
for GT27 (SVGA)

Personal computer

Package data
 for GT27 (VGA)

Write

Write

GOT type change

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Screen size

(2) Channel No. setting
When the newly set GOT does not have the channel No. that the changed GOT has, the default value is set in the channel 
No.
When a channel No. with the default value is already used in another interface, the channel No. is set to 0.
When the newly set GOT does not have the communication driver set for the channels of the changed GOT, the default 
communication driver is set.

(3) Device settings
The incompatible device range with the newly set GOT is shown as [??] in GT Designer3.
In this case, set the device again.
The devices with device types (BCD, real number) that the newly set GOT does not support are deleted.

(4) Project security
When the project security is set, the following user cannot change the GOT type.

• Users who are restricted to edit the project by the project security
• Users who are restricted to display or edit a screen

➟2.13 Protecting a Project by Registering Users

(5) Channel No. setting of the special function switch
When the GOT type is changed, if the channel No. set for the special function switch does not exist, the channel No. is 
automatically changed.
When either of the following functions is set for the special function switch, check the channel No. of the special function 
switch.

• [System Launcher]
• [Device Monitor]
• [Backup/Restoration]

(6) Image data (BMP)
(a) Changing 16-tone monochrome to 256 or 65536 colors

When the GOT type is changed, the number of bits per pixel of 16-tone monochrome image data cannot be held.
The image data is converted to the image data with either 8 bits or 16 bits.
Thus, the data size of the image data is increased.

(b) Restriction due to the arrangement method
When using image data of BMP files (256 colors), use the same method to display all the image data.
The color of the image data of BMP files (256 colors) may be changed depending on the arrangement method at the GOT 
type change.

• Importing the BMP file by selecting [Figure] → [Import Image Data] from the menu
The image data is displayed in 8-bit color.

• Copying the BMP file to the clipboard and pasting it on the screen
The image data is displayed in 16-bit color.

(7) Startup logo setting
When the screen size of the newly set GOT does not correspond to that of the changed GOT, the size of the startup logo 
may be changed.
When the screen size has been changed, set the startup logo again.

Screen type Description

Original-size base screen

When the GOT type is changed to one with a different screen resolution, the base screens are resized 
to the screen size of the newly-selected GOT.
Select whether to reposition and resize the figures and objects on the screens.
For information on how the screen data is converted, refer to the following.

➟5.1.1 ■4 Resizing the screens, figures, and objects

Expanded base screen Select whether to resize the screens.
For information on how the screen data is converted, refer to the following.

➟5.1.1 ■4 Resizing the screens, figures, and objectsWindow screen
5. COMMON SETTING
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■4 Resizing the screens, figures, and objects
In the [Type Setting] dialog, change the GOT type to one with a different screen resolution and click the [OK] button to 
display the dialog prompting you to specify the method of changing the figures and objects on the screens.
How the screen data is converted depends on the types of the base screens before the GOT type change and the method 
of changing the figures and objects on the screens.
For more details, refer to the following.

➟(1) How the original-size base screen data is converted
(2) How the expanded base screen data is converted (when enabling the base screen size expansion for 
the newly-selected GOT)
(3) How the expanded base screen data is converted (when disabling the base screen size expansion for 
the newly-selected GOT)
(4) How the window screen data is converted

1) Method of changing the figures and objects
Select whether to reposition and resize the figures and objects according to the screen size of the newly-selected 
GOT.
The following shows selectable items.

Item Description

[Retain the positions/sizes]

Resizes the screens, and does not reposition and resize the figures and objects on the screens.
If the screen size of the newly-selected GOT is smaller than the screen size of the originally-selected 
GOT, some of the figures and objects may enter the temporary area.
In this case, move such figures and objects to the screen display area.
If the screen size of the newly-selected GOT is larger than the screen size of the originally-selected 
GOT, click the [OK] button to display the following dialog.

• Position of the figures and objects
Select where to place the figures and objects on the base screens after the GOT type change.
The following items are selectable: [Top Left], [Top Right], [Center], [Bottom Left], [Bottom Right], 
[Top], [Bottom], [Left], and [Right].

[Perform automatic scaling on the 
positions/sizes to fit the screen sizes]

Repositions and resizes the figures and objects according to the new screen size.
How they are repositioned and resized depends on them.

➟(5) How the figures and objects are changed
The setting of [Resize objects in the fixed frame width edit mode] determines whether to fix the 
object shape frame widths after the GOT type change.

3)

2)

1)

Position of the figures and objects
5 - 4 5. COMMON SETTING
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2) [Option]
This item appears when [Perform automatic scaling on the positions/sizes to fit the screen sizes] is selected as the 
method of changing the figures and objects.

3) [About Automatic Scaling] button
This item appears when [Perform automatic scaling on the positions/sizes to fit the screen sizes] is selected as the 
method of changing the figures and objects.
Displays precautions for the automatic scaling.

(1) How the original-size base screen data is converted
The original-size base screen data is converted as shown below.

Item Description

[Apply to expanded base screens]

Available to GT27, GT25, and GS25.
This item is displayed when the base screen size expansion is available for both the originally-
selected GOT and newly-selected GOT.
Resizes the figures and objects on the expanded base screens.
Resizes the expanded base screens.
For information on how the expanded base screen data is converted, refer to the following.

➟(2) How the expanded base screen data is converted (when enabling the base screen size 
expansion for the newly-selected GOT)

(3) How the expanded base screen data is converted (when disabling the base screen size 
expansion for the newly-selected GOT)

[Apply to Window Screen]

Resizes the figures and objects on the window screens.
Resizes the window screens.
For information on how the window screen data is converted, refer to the following.

➟(4) How the window screen data is converted

[Resize objects in the fixed frame width 
edit mode]

Resizes the applicable objects with their shape frame widths fixed. The objects must satisfy the 
frame width fixing conditions.
For the frame width fixing conditions, refer to the following.

➟6.6.13 [Edit Objects with Fixed Frame Width]
The shape frame widths are fixed after the GOT type change.

Method of changing the figures and objects Conversion specifications

[Retain the positions/sizes]

The base screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are not repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

[Perform automatic scaling on the positions/sizes to fit the 
screen sizes]

The base screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are repositioned and resized in proportion to the 
screen resolution of the originally-selected GOT.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Base screen (640 × 480) Base screen (800 × 600)

Original screen size (640 × 480)

Base screen (640 × 480) Base screen (800 × 600)

Original screen size (640 × 480)
5. COMMON SETTING
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(2) How the expanded base screen data is converted (when enabling the base screen size expansion for 
the newly-selected GOT)
If you enable the base screen size expansion for the newly-selected GOT, the expanded base screen data will be 
converted as shown below.

Method of changing the 
figures and objects

[Apply to expanded base 
screens] Conversion specifications

[Retain the positions/sizes] -

The base screens are not resized, and the figures and objects on the screens are not 
repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Note that the screens are resized under the following condition.
• The vertical or horizontal size of the screens is smaller than the vertical or horizontal 

screen size of the newly-selected GOT.
The screens are resized to the screen size of the newly-selected GOT.

Expanded base screen
 (1280 × 960)

Expanded base screen
 (1280 × 960)
5 - 6 5. COMMON SETTING
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[Perform automatic scaling on 
the positions/sizes to fit the 
screen sizes]

Selected

The base screens are resized and the figures and objects on the screens are repositioned 
and resized in proportion to the screen resolution of the originally-selected GOT.
The base screen expanded to an integral multiple of the original size is resized 
proportionally.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Note that the specifications vary under the following conditions.
• Even after the screens are resized in proportion to the screen resolution of the originally-

selected GOT, the vertical or horizontal size of the screens is smaller than the vertical or 
horizontal screen size of the newly-selected GOT.
The screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are repositioned and resized based on the ratio 
of the base screen sizes before and after the GOT type change.

• Even after the screens are resized in proportion to the screen resolution of the originally-
selected GOT, the vertical or horizontal size of the screens exceeds 3000 dots.
The base screens are not resized, and the figures and objects on the screens are not 
repositioned and resized.

Deselected

The base screens are not resized, and the figures and objects on the screens are not 
repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Note that the screens are resized and the figures and objects on the screens are 
repositioned and resized under the following conditions.
• The vertical or horizontal size of the screens is smaller than the vertical or horizontal 

screen size of the newly-selected GOT.
The screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are repositioned and resized based on the ratio 
of the base screen sizes before and after the GOT type change.

Method of changing the 
figures and objects

[Apply to expanded base 
screens] Conversion specifications

Expanded base screen
 (1280 × 960)

Expanded base screen
 (1600 × 1200)

Original screen size (1280 × 960)

Expanded base screen
 (1280 × 960)

Expanded base screen
 (1280 × 960)
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(3) How the expanded base screen data is converted (when disabling the base screen size expansion for 
the newly-selected GOT)
The base screen size expansion is disabled under the following conditions.

• The newly-selected GOT does not support the base screen size expansion.
• The setting of [Graphics Setting] has been changed from [GOT Graphic Ver.2] to [GOT Graphic Ver.1].
• [Expand base screen sizes] is deselected.

If you disable the base screen size expansion for the newly-selected GOT, the expanded base screen data will be 
converted as shown below.

(4) How the window screen data is converted
The window screen data is converted as shown below.

Method of changing the figures and objects Conversion specifications

[Retain the positions/sizes]

The base screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are not repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT2104-R (480 × 272)

[Perform automatic scaling on the positions/sizes to fit the 
screen sizes]

The base screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are repositioned and resized based on the ratio of 
the base screen sizes before and after the GOT type change.
Example) Changing the GOT type from GT27-V (640 × 480) to GT2104-R (480 × 272)

Expanded base screen
 (1280 × 960) Base screen (480 × 272)

Original screen size (1280 × 960)

Expanded base screen
 (1280 × 960) Base screen (480 × 272)

Original screen size (1280 × 960)

Method of changing the 
figures and objects [Apply to Window Screen] Conversion specifications

[Retain the positions/sizes] -

The window screens are not resized, and the figures and objects on the screens are not 
repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Note that the screens are resized under the following condition.
• The vertical or horizontal size of the screens is larger than the vertical or horizontal screen 

size of the newly-selected GOT.
The screens are resized to the screen size of the newly-selected GOT.

Window screen (320 × 240) Window screen (320 × 240)
5 - 8 5. COMMON SETTING
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(5) How the figures and objects are changed
The figures and objects are repositioned and resized based on the ratio of the base screen sizes before and after the 
GOT type change.
How the figures and objects are changed depends on them.

○: Changed, ×: Not changed

[Perform automatic scaling on 
the positions/sizes to fit the 
screen sizes]

Selected

The window screens are resized and the figures and objects on the screens are 
repositioned and resized in proportion to the screen resolution of the originally-selected 
GOT.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Deselected

The window screens are not resized, and the figures and objects on the screens are not 
repositioned and resized.
Example) Changing the GOT type from GT27-V (640 × 480) to GT27-S (800 × 600)

Note that the screens are resized and the figures and objects on the screens are 
repositioned and resized under the following condition.
• The vertical or horizontal size of the screens is larger than the vertical or horizontal screen 

size of the newly-selected GOT.
The screens are resized to the screen size of the newly-selected GOT.
The figures and objects on the screens are repositioned and resized based on the ratio 
of the base screen sizes before and after the GOT type change.

Method of changing the 
figures and objects [Apply to Window Screen] Conversion specifications

Window screen (320 × 240) Window screen (400 × 300)

Original screen size (320 × 240)

Window screen (320 × 240) Window screen (320 × 240)

Function
Specifications

Size Other than size

Figure ○

For the text and the logo text, the setting of [Size] is changed.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].

Touch Switch ○

The setting of [Text Size] is changed.
When [Adjust Text Size] is selected, the setting of [Minimum Size] is also changed.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].

Lamp ○

The setting of [Text Size] is changed.
When [Adjust Text Size] of the bit lamp or word lamp is selected, the setting of 
[Minimum Size] is also changed.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
5. COMMON SETTING
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Numerical Display/Input ○

The setting of [Number Size] is changed according to the object size.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
When [Font] is set to [6x8dot], the object size is not changed.

Text Display/Input ○

The setting of [Text Size] is changed according to the object size.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
When [Font] is set to [6x8dot], the object size is not changed.

Date/Time Display ○

The setting of [Number Size] is changed according to the object size.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
When [Font] is set to [6x8dot], the object size is not changed.

Comment Display ○ The setting of [Text Size] is changed.

Parts Display ○ -

Parts Movement ○ When [Move Way] is set to any other than [Line], the object size is not changed.

Historical Data List Display ○ The setting of [Text Size] is changed.

Alarm Display ○

The setting of [Text Size] is changed.
When [Font] is set to [6x8dot], the following items are not changed.
• Object size
• Setting of [Space] of the alarm display (user) or the alarm display (system)

Recipe Display (Record List) ○

The setting of [Text Size] and the scroll bar width are changed.
When [Font] is set to [6x8dot], the following items are not changed.
• Object size
• [Space]

Graph ○ The setting of [Number Size] is not changed.

Graphical Meter ○

The setting of [Text Size] is changed.
When [Adjust Text Size] is selected, the setting of [Minimum Size] is also changed.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
The setting of [Numerical Size] is not changed.

Meter ○

For the panelmeter, the setting of [Text Size] is changed.
The setting of [Font] is changed as shown below.
• [12dot Standard] is changed to [16dot Standard Gothic] ([16dot Standard] for GT21 

and GS21).
• [16dot Standard Gothic] ([16dot Standard] for GT21 and GS21) is changed to [12dot 

Standard].
The setting of [Number Size] is not changed.

Slider ○ The setting of [Number Size] is not changed.

Document Display ○ -

Script parts × -

Video/RGB display object ○ -

Window Position × -

Key Window Object ○
The setting of [Text Size] is changed according to the object size.
When [Font] is set to [6x8dot], the object size is not changed.

Hyperlink × -

Function
Specifications

Size Other than size
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■5 Project data for GOT1000 series
When project data for GOT1000 series is opened, the data is converted for GOT2000 series.
For the compatibility between project data for GOT1000 series and project data for GOT2000 series, refer to the following.

➟12.13 Compatibility with Conventional Products

5.1.2 Graphics mode ([Graphics Setting])

The following shows the graphics modes of the GOT.
• GOT Graphic Ver.2
• GOT Graphic Ver.1

For GT23, only GOT Graphic Ver.1 is available.

GOT Graphic Ver.2 is optimized for the GOT2000 series, and it supports the following graphics.
• Screen background color gradient
• Semitransparent window screen
• Selectable contours of the window screen

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.1GOT Graphic Ver.2
5. COMMON SETTING
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■1 Specifications of the graphics modes
The following shows the specifications of GOT Graphic Ver.2 and GOT Graphic Ver.1.
(Some items may not be available depending on the GOT type.)

(1) Screen

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Base screen

Screen background color 
gradient Available Not available

Screen background pattern The specified pattern is cut off at the edges 
of the relevant screen.

The relevant screen is outlined in the 
pattern color.

Transparent color setting for 
the front layer Not available Available

Size expansion Available Not available

Window screen

Screen background color 
gradient Available Not available

Screen background pattern The specified pattern is cut off at the edges 
of the relevant screen.

The relevant screen is outlined in the 
pattern color.

Transparent color setting for 
the front layer Not available Available

Changing the title bar design 
of the overlap window Available Not available

Changing the standard key 
window design Available Not available

Changing the title bar design 
of the user-created key 
window

Available Not available

Setting the transparency of 
the window screen Available Not available

Setting the contours of the 
window screen

[Rectangle] or [Rounded] is selectable.
When [Rounded] is selected, [Radius] can 
be set.

[Rectangle] (fixed)

Display of a moving window The window becomes semitransparent. The color of the title bar changes.

Cursor on the key window A semitransparent rectangle cursor 
appears. A white rectangle cursor appears.

Display of a user-created 
dialog window

All screens are refreshed.
The screens other than the dialog window 
appear dark.

The screens other than the dialog window 
are not refreshed.

Mobile screen

Behavior when a dialog 
window is displayed Available Not available

Screen background pattern The specified pattern is cut off at the edges 
of the relevant screen.

The relevant screen is outlined in the 
pattern color.
5 - 12 5. COMMON SETTING
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(2) Common setting

(3) Figure

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Graphics accelerator Not available Available

Antialiasing

Always enabled.
The following shows the targets to which 
antialiasing is applied.
• Outline font
• Basic figure in the library
• Line
• Freeform line
• Rectangle
• Polygon
• Circle
• Arc
• Sector
• Piping
• Lines plotted on a line graph
• Points plotted on a trend graph (excluding 

the plotted straight lines)
• Outline and demarcation lines of a 

statistics pie graph
• Points plotted on a scatter graph
• Points plotted on a historical trend graph 

(excluding the plotted straight lines)
• Needle (whose shape is not set to 

[Straight Line]), meter frame, meter panel, 
core of a panelmeter

• Figure drawn with a free figure drawing 
function (other than the d_line, d_textout, 
and d_commentout functions)

Antialiasing is applied when the above 
targets are displayed on the GOT.
Antialiasing is not applied when the above 
targets are displayed on GT Designer3.

Enabled or disabled by the user
Antialiasing is applied to outline fonts.

Object stacking order adjustment Always enabled. Enabled or disabled by the user

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Paint Not available Available
5. COMMON SETTING
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(4) Object

(5) Function running in the background on the GOT

(6) Function using peripheral devices

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Inverting the colors in the touch switch area ([Shape]: 
[None]) Not available Available

Lamp area Not available Available

Display mode of the numerical display and the 
numerical input [Transparent] (fixed) [Transparent] or [XOR] is selectable.

Cursor on the numerical input or the text input A semitransparent rectangle cursor blinks. A white rectangle cursor blinks.

Display mode of the comment display [Transparent] (fixed) [Transparent] or [XOR] is selectable.

Display mode of the parts display (bit, word, or fixed 
parts) [Replace] (fixed for all types of parts) [Replace], [XOR], or [Overwrite] is 

selectable.

Display mode of the parts movement (bit, word, or 
fixed parts) [Movement] (fixed) [Movement] or [Locus] is selectable.

Movement methods for the parts movement (bit, 
word, or fixed parts) Available for [Circle] Not available for [Circle]

Scatter graph ([Graph Type]: [Sample], [Store 
Memory]: Deselected)

Available
If the number of the plotted points or lines 
exceeds 1000, the oldest point or line is 
deleted and a new one is plotted.

Available
Scatter graph ([Graph Type]: [Batch], [Display Mode]: 
[Locus], [Store Memory]: Deselected)

Level object
Available
[Boundary Color] cannot be set.

Available

Display order when an object is superimposed on a 
level object (Object stacking order adjustment: 
enabled)

The display order conforms to the object 
stacking order.

The level object is displayed behind the 
other object regardless of the object 
stacking order.

Video/RGB display object

Available
If a semitransparent window is displayed 
directly in front of the video/RGB display 
object, the screen background color 
becomes visible through the object.

Available

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Color of the text selected on the alarm display (user 
or system) [XOR] (fixed) [Reverse] or [XOR] is selectable.

Alarm popup display A semitransparent popup window appears. An opaque popup window appears.

Free figure drawing function of the object script

The maximum number of the text figures 
drawn with the d_textout or d_commentout 
function differs depending on the number of 
lines in the text figure.
Example)
• One-line text: 1280 figures
• Two-line text: 640 figures

Up to 1280 figures can be drawn.

Item
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Remote personal 
computer operation 
(Ethernet)

Window display mode Available Available

Full screen mode Available Not available

Displaying the video images of the multimedia 
function on a user-created screen

Available
If a semitransparent window is displayed 
directly in front of the video window, the 
background color of the user-created 
screen becomes visible through the video 
window.

Available
5 - 14 5. COMMON SETTING
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5.1.3 Base screen size expansion ([Expand base screen sizes])

Create a base screen that is larger than the GOT screen.
You can scroll the screen by using swipe gestures or the scroll bars.
Example) Displaying an expanded base screen (1600 × 960) on GT27-V (640 × 480)

■1 Settings of the base screen size expansion
To enable the base screen size expansion, select [Expand base screen sizes] in [Basic Setting] in the [Type Setting] 
dialog.

➟5.1.5 ■1 [Basic Setting]
To change the size of each base screen, open the [Basic] tab in the [Screen Property] dialog for the screen.

➟2.7.1 ■1 [Basic] tab
To change the size of multiple base screens in one go, select base screens in the [Screen] window and display the 
[Screen Property] dialog.

➟2.2.4 ■3 [Screen] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.2

View on the GOT

Scroll

Expanded base screen (1600 × 960)
5. COMMON SETTING
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■2 Screen editors for editing the expanded base screens
When you edit an expanded base screen, the following lines appear on the screen editor.
The lines are invisible on the GOT.

Example) Displaying an expanded base screen (1600 × 960) on GT27-V (640 × 480)
The scroll bar areas are not displayed because the base screen is vertically and horizontally expanded.

Example) Displaying an expanded base screen (1600 × 480) on GT27-V (640 × 480)
A solid line representing the scroll bar area is displayed in the lower part of the base screen because the screen is 
horizontally expanded.
A scroll bar appears in the scroll bar area when the base screen is displayed on the GOT.

Whether to display the lines and the color of the lines are selectable.
➟2.6.7 Displaying the scroll bar areas for editing the expanded base screens

11.10.5 Customizing the display
The scroll bars are viewable in the screen preview.

➟2.9.1 Displaying a preview
The design of the scroll bars depends on the screen design selected.

➟2.4.3 [Screen Design] dialog
In the following cases, no scroll bar is displayed on the GOT, and no lines representing the scroll bar areas and partitions 
for GOT screens are displayed on the screen editors.

• The base screen is smaller than the GOT screen.
• The scroll bars are set to be hidden.

Line type Description

Solid line

Appears when either the vertical or horizontal size of the base screen is larger than the vertical or horizontal 
size of the GOT screen.
Represents the areas of the scroll bars to appear on the GOT.
Appears 40 dots from the right or bottom edge of the screen display area.
Place figures and objects so that they do not overlap the scroll bar areas.

Dotted line

Represents a partition for one GOT screen.
Represents partitions for multiple GOT screens.
The lines are usable as guidelines to specify the size of a base screen to an integral multiple of the GOT 
screen size.

View on the GOT

View on the screen editor

Dotted lines representing partitions for GOT screens

Scroll bar

View on the GOT

View on the screen editor

Scroll barSolid lines representing the scroll bar areas

Scroll bar area

Dotted lines representing partitions for GOT screens
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■3 Operation of the GOT displaying an expanded base screen
(1) Refreshing the display of the objects while the screen is being scrolled

The display of the objects are refreshed while the screen is being scrolled.

(2) Movements of the windows while the screen is being scrolled
The following shows how the windows move while the screen is being scrolled.

For the precautions for specifying the display positions of the overlap windows and key windows, refer to the following.
➟5.1.3 ■5 (4) Specifying the display positions of the overlap windows and key windows

(3) Switching the current screen to an expanded base screen
When the current screen switches to an expanded base screen, the upper-left corner of the expanded base screen 
appears on the GOT.
To specify any other area of the base screen to appear on the GOT, use GS635.b0, GS636, and GS637.

➟12.1.3 GOT special register (GS)
The position of the area displayed before screen switching is retained.
The position will be cleared if the following events occur.

• The GOT is turned off.
• The GOT is restarted by writing project data to the GOT.

(4) Size of images displayable on the expanded base screens
The size of images displayable on the GOT screen depends on the image file format.

*1 For using a BMP file stored in the data storage as a part
*2 For pasting an image on a screen editor or parts editor in GT Designer3

Window type Operation

Superimpose window

The window as well as the figures and objects on the screen move along the screen while the screen is being 
scrolled.
Example) When displaying superimpose window 1

Other windows

The window keeps its current position on the GOT screen while the screen is being scrolled.
Example) When displaying overlap window 1

View on the screen editor

Superimpose window 1

View on the GOT

Scroll

Superimpose window 1

View on the screen editor

Overlap window 1

View on the GOT

Scroll

Overlap window 1

Image file format Displayable size on the GOT screen

BMP *1

JPEG
PNG

Up to the size of the GOT screen with the base point at the upper left corner of the image

BMP *2 Up to 2000 dots × 1600 dots with the base point at the upper left corner of the image
5. COMMON SETTING
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■4 Scrolling the expanded base screens
To scroll the expanded base screens on the GOT, perform the following operations.

• Swiping the GOT screen
• Using the scroll bars
• Using the navigation window

(1) Swiping the GOT screen
Swipe somewhere on the GOT screen where no object is displayed to scroll the base screen.
To disable swiping to scroll the screen, turn on GS635.b1.

(2) Using the scroll bars
Touch the scroll keys or drag the handle to scroll the screen.
The scroll bars are displayed at the right and bottom edges of the GOT screen.

Each scroll bar is displayed when the vertical or horizontal size of the base screen is larger than the vertical or horizontal 
size of the GOT screen.
Example) Displaying an expanded base screen (1280 × 480) on GT27-V (640 × 480)
A scroll bar is displayed only at the bottom edge of the GOT screen.

Whether to display the scroll bars is selectable.
➟5.1.5 ■1 (1) [Display Setting] dialog (Base screen size expansion)

Item Description

Handle Drag the handle to scroll the screen.

Track Touch somewhere on the track to scroll the screen one page.

Scroll key Touch the scroll key to scroll the screen one dot.

Scroll key Scroll key

Handle Track

View on the GOTView on the screen editor

1280 dots

480 dots
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(3) Using the navigation window
The navigation window shows your current location within the base screen.
The window is semi-transparent and one-ninth the size of the GOT screen.
Touch or swipe anywhere in the window to bring that point to the center of the GOT screen.

Objects behind the window are inoperable.
The following items appear in the window.

You can specify the display timing and position of the navigation window.
➟5.1.5 ■1 (1) [Display Setting] dialog (Base screen size expansion)

When the cursor moves to any object that is hidden from view, the navigation window appears for two seconds, 
regardless of the display timing setting.
For the precautions for the navigation window, refer to the following.

➟5.1.3 ■5 (7) Displaying the navigation window and the comment window
5.1.3 ■5 (14) Display of the navigation window while a switch is being touched

■5 Precautions for the base screen size expansion
(1) Scrolling the screen and operating the objects on the screen

While scrolling the base screen, you cannot operate the objects on the screen.
You also cannot scroll the screen while operating any of the objects.

(2) Placing objects and the navigation window
Objects behind the navigation window are displayed but inoperable.
When placing an object to be operated on a base screen, make one of the following settings.

• Position the object so that it will not be overlapped by the navigation window.
• Select [While swiping/touching the screen] or [Not display] for [Display Timing].

For setting the timing to display the navigation window, refer to the following.
➟5.1.5 ■1 (1) [Display Setting] dialog (Base screen size expansion)

(3) Screen gesture function
You cannot enlarge or reduce the size of the base screen using the screen gesture function.

Item Description

Red frame Indicates the area of the base screen currently displayed on the GOT.

Blue frame
(The area enclosed in the frame blinks in 
yellow.)

Indicates the position of the object where the cursor is located.
The frame appears when the cursor moves to any object that is hidden from view.

Blue frame

Red frame
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(4) Specifying the display positions of the overlap windows and key windows
When the following setting is configured, specify the display positions of the overlap windows and key windows so that 
the windows fit in the GOT screen.

• Setting of [Display windows beyond the screen area] for [Screen Switching/Window] in the [Environmental Setting] 
window

➟5.2.1 ■5 [Screen Switching/Window]
The overlap windows and key windows outside the GOT screen cannot be displayed on the GOT even the GOT screen 
is scrolled.
The following shows how to specify the display positions of the overlap windows and key windows.

(5) Displaying images on the expanded base screens
If the following images (including figures and logo text) are displayed on a GOT screen, refreshing the screen may be 
delayed.

• Images (JPEG or PNG) that are larger than the size of the GOT screen
• Two or more images (JPEG or PNG) that are almost the same size as the GOT screen
• Large images (JPEG or PNG) that are displayed on the parts display objects and the parts movement objects

(6) Setting a shape for an object
When an object filled with a pattern is placed on an expanded base screen, the start point of the pattern may be different 
from the start point of the pattern of the object placed on an unexpanded base screen.
Note that the screen tends to flicker while scrolled.

(7) Displaying the navigation window and the comment window
The navigation window cannot be displayed simultaneously with the comment window for the following functions.

• Alarm display (user)
• Simple alarm display

If the navigation window is set to always be displayed, the comment window will not appear.

(8) Calling the expanded base screens using the set overlay screen function
When you use the set overlay screen function, you can call the expanded base screens.
The screen size settings of the calling base screen are applied to the expanded base screens called.
You can scroll the called screens within the calling base screen.

(9) Object scripts
Object scripts run even when the objects that correspond to the scripts are hidden from view on the GOT.
The free figure drawing function draws figures even in the hidden area of the expanded base screens.

Window type Method

Overlap window

Place a window position object on the screen.

➟8.30 Specifying the Display Position of a Window Screen

Specify the overlap window display position with a display position specification device.
Select [Display Position] in [Screen Switching/Windows] of the [Environmental Setting] window to 
enable the display position specification device setting.

➟5.2.1 ■5 [Screen Switching/Window]

Key window

Place a window position object on the screen.

➟8.30 Specifying the Display Position of a Window Screen

Configure either of the following settings to display a key window near an object.
• In the [Environmental Setting] window ([Key Window]), [Key Window Position Correction] is set to 

[Around the object] on the [Advanced Setting] tab.

➟5.2.4 ■4 (2) [Advanced Setting] tab
• In the [Screen Property] dialog for the base screen, [Key Window Position Correction] is set to 

[Around the object] on the [Key Window Advanced Setting] tab.

➟2.7.1 ■3 [Key Window Advanced Setting] tab

Specify the display position of a key window with the key window display switch.

➟8.2.10 ■1 [Key Input] tab
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(10)Functions that use popup displays
When a popup display overlaps the scroll bar at the bottom edge of the GOT screen, switch the position of the popup 
display by touching the popup display.
The following shows the functions that use popup displays.

• SoftGOT-GOT link function
• GOT network interaction function
• Alarm popup display
• VNC server function

In the [Alarm Popup Display] dialog, if you set [Display Position Switching] to [None] on the [Basic] tab, you cannot switch 
the position of the popup display.
You are recommended to select [Switch] for [Display Position Switching].

➟9.1.4 ■4 [Alarm Popup Display] dialog

(11)Screenshots captured by using the hard copy function
The hard copy function captures only the area of the expanded base screen currently displayed on the GOT.
The scroll bars and navigation window are captured in screenshots.

(12)Screen image display for the operation log information
If you select the log event that a user has operated any object on the expanded base screen, the image window for the 
event will not display the image of the entire base screen.
The window displays the image of the area which is centered around the object. The area fits with the GOT screen.

(13)Unintended object operation by swiping on the GOT screen
To avoid an unintended object operation by swiping on the GOT screen, turn on GS635.b1 to disable swiping to scroll 
the screen, and use the scroll bar or the navigation window to scroll the screen.

(14)Display of the navigation window while a switch is being touched
Although [While swiping/touching the screen] is set for the display timing of the navigation window, the window is not 
displayed while a switch is being touched.
During that time, the displayed objects are not refreshed.

■6 Settings relevant to the base screen size expansion
Set the relevant settings other than the specific settings for the base screen size expansion as required.
The following shows the functions that are available by configuring the relevant settings.

(1) GOT internal devices
➟12.1.3 GOT special register (GS)

Function Setting item

Specifying the upper-left coordinates of the area of the expanded base screen to be displayed on the GOT
GS635.b0
GS636
GS637

Disabling swiping to scroll the screen GS635.b1

Notifying the upper-left coordinates of the area of the expanded base screen currently displayed on the GOT
GS696
GS697
5. COMMON SETTING
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5.1.4 Precautions

For the precautions for the base screen size expansion, refer to the following.
➟5.1.3 ■5 Precautions for the base screen size expansion

■1 Settings before the GOT type change
The settings that have been changed through the GOT type change cannot be restored.
The operation history of [Undo] is deleted at the GOT type change.
Saving the project before the GOT type change is recommended.

■2 Exiting GT Simulator3
Check that GT Simulator3 is not started before the GOT type change.
If the GOT type or the language of the standard font has been changed, the running GT Simulator3 is terminated.

■3 Operation when the GOT is installed vertically
When you install the GOT vertically, the GOT operates as follows.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Operation at GOT vertical installation

Utility The contents appear horizontally.

Monitor screen, data screen, or other screens called 
up from the utility

The screen appears horizontally.
However, the following screens appear vertically.
• Recipe operation window

User-created screen
The screen created according to the vertical installation is displayed.
The key window and dialog window on the user-created screen are also displayed according to 
the vertical installation.

Startup logo The startup logo appears according to the vertical installation.

Utility call key
The key is positioned according to the vertical installation.
When the key is set to the upper left corner, the key is positioned on the upper left corner 
according to the vertical installation.

Remote Personal Computer Operation (Ethernet) The remote personal computer operation function (Ethernet) cannot be used.

Remote Personal Computer Operation (Serial) The touched position on the GOT is notified by using the upper left corner as the origin (0, 0) of 
coordinates according to the vertical installation.

VNC Server The contents appear on the VNC client according to the vertical installation.

SoftGOT-GOT link function The contents appear on GT SoftGOT2000 according to the vertical installation.

Video Display

The images taken with a video camera do not rotate, and appear horizontally.
For the video window, the width and height of the display size and clip area are specified 
according to the horizontal installation.
The video window display position is specified with the coordinates of the window upper left 
corner.
The origin (0, 0) is on the GOT upper left corner according to the vertical installation.

RGB Display

The images of a personal computer are displayed in the resolution according to the vertical 
installation.
For the RGB screen, the width and height of the display size and clip area are specified 
according to the horizontal installation.
The RGB screen display position is specified with the coordinates of the screen upper left 
corner.
The origin (0, 0) is on the GOT upper left corner according to the vertical installation.

Video output function
The contents appear on the external display according to the vertical installation.
If you set vertical installation for the GOT and create a screen, use the display vertically.

Multimedia
The images taken with a video camera do not rotate, and appear horizontally.
The multimedia screen of the utility appears horizontally.

Popup window
The popup window appears according to the vertical installation.
However, the popup window does not support the scrolling display.
When text extends off the screen, you cannot check the portions of text lying offscreen.

Hard Copy Capturing images is performed according to the vertical installation.

USB mouse The mouse pointer is displayed according to the vertical installation.

Touch status external notification (X-
coordinate)(GS654), Touch status external 
notification (Y-coordinate)(GS655)

The coordinates are notified by using the upper left corner as the origin (0, 0) according to the 
vertical installation.
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■4 Renaming the package folder
If you change the setting of [Package Folder Name] in the [Type Setting] dialog, the path to the public folder of the GOT 
Mobile function is automatically changed accordingly.
With the change of the package folder name, if the path to a file in the public folder contains more than 78 characters, 
the file becomes inaccessible.
For the details of the public folder in the GOT Mobile function, refer to the following.

➟10.19.2 ■7 Public folder

■5 Precautions for the object stacking order adjustment setting

The object stacking order adjustment is always enabled.

To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] 
in [Option Setting] of the [Type Setting] dialog.

The following shows the functions to which the object stacking order adjustment is not applied.

(1) Objects for which the set stacking order is invalid
The following objects always appear in the front on a layer under specific conditions.
The object stacking order may not match between GT Designer3 and the GOT accordingly.

(2) Free figure drawing function of the object script

The figure drawn by the free figure drawing function of the object script is designed to appear in the front on a layer.
Even if the blink is set for the object using the free figure drawing function, the figure drawn by the function does not blink.

The figure drawn by the free figure drawing function of the object script is designed to appear in the front on a layer.
Therefore, the object stacking order may not match between GT Designer3 and the GOT under the following conditions.
• The figure drawn by the function overlaps an object for which the set stacking order is invalid.
• The figure drawn by the function overlaps stacked objects on a layer.
Even if the blink is set for the object using the free figure drawing function, the figure drawn by the function does not blink.

GOT Graphic Ver.2

GOT Graphic Ver.1

Object Condition

Scatter graph (Points on the graph only)

[Graph Type] is set to [Sample] on the [Data] tab, and [Store Memory] is not selected on the 
[Extended] tab.

[Graph Type] is set to [Batch], and [Display Mode] is set to [Locus] on the [Data] tab. [Store 
Memory] is not selected on the [Extended] tab.

Object Condition

Scatter graph (Points on the graph only)

[Graph Type] is set to [Sample] on the [Data] tab, and [Store Memory] is not selected on the 
[Extended] tab.

[Graph Type] is set to [Batch], and [Display Mode] is set to [Locus] on the [Data] tab. [Store 
Memory] is not selected on the [Extended] tab.

Parts display [Display Mode] is set to [Overwrite].

Parts movement [Display Mode] is set to [Locus].

Alarm display (user) The scrolling display setting is made.

Alarm display (system) The scrolling display setting is made.

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.2

GOT Graphic Ver.1
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(3) Object display color

If you set the screen transparent color ([Screen Property]) for an object for which the set stacking order is invalid, the 
object is invisible because of the transparent processing. (Regardless of the layer on which the object is placed)
When you select [Adjust object display order in GOT to the one in GT Designer3], specify a color different from the screen 
transparent color for such an object.

5.1.5 [Type Setting] dialog

In the [Type Setting] dialog, set the model of the GOT to be used and the standard font.
Select [Common] → [GOT Type Setting] from the menu to display this dialog.

➟■1 [Basic Setting]
■2 [Language and Font Setting]
■3 [Option Setting]

GOT Graphic Ver.1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Basic Setting]

1) [Original GOT Type]
Displays the GOT type before the type is changed.
This item is active only when the project for GOT1000 series is to be converted forGOT2000 series.

2) [Backlight]
This item appears only when the GOT type is converted from GT1030 or GT1020 toGOT2000 series.
Select the display color of the backlight for the GOT type before the change.
The following shows the items to be selected.

• [Green/Red/Orange]
• [White/Red/Pink]

3) [Series]
Select the GOT series.
The following shows the items to be selected.

• [GOT2000]
• [GS Series]

4) [Type]
Set the GOT type.
The following shows the items to be selected.

• When [GOT2000] is selected for [Series]
[GT27**-X(1024x768)]
[GT27**-S (800x600)]
[GT27**-V (640x480)]
[GT2705-V (640x480)]
[GT25**-WX (1280x800)]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)
4)
5)

7)
8)
9)

10)
11)

6)

12)

For GT SoftGOT2000

When a GOT1000 project is converted to a GOT2000 project

1)
2)

13)
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[GT25**-W (800x480)]
[GT25**-S (800x600)]
[GT25**-V (640x480)]
[GT2505-V(640x480)]
[GT23**-V (640x480)]
[GT2107-W (800x480)]
[GT2105-Q (320x240)]
[GT2104-R (480x272)]
[GT2104-P (384x128)]
[GT2103-P (320x128)]
[GT SoftGOT2000]

• When [GS Series] is selected for [Series]
[GS25**-WX (1280x800)]
[GS21**-W-N (800x480)]
[GS21**-W (800x480)]

When this item has been changed, the confirmation dialog for the change appears.
➟5.1.1 ■4 Resizing the screens, figures, and objects

5) [Model]
Displays the models of the GOT type selected in [Type].

6) [Resolution]
Only available to GT SoftGOT2000.
Select the resolution of GT SoftGOT2000.
The following shows the items to be selected.

• [MI3315G-W (1024x768)]
Select [Full Screen Mode] or [Window Mode].

• [MI3321G-W (1920x1080)]
Select [Full Screen Mode] or [Window Mode].

• [VGA (640x480)]
• [SVGA (800x600)]
• [XGA (1024x768)]
• [HD (1280x720)]
• [WXGA (1280x800)]
• [FWXGA (1366x768)]
• [Full HD (1920x1080)]
• [WUXGA (1920x1200)]

To customize the resolution, set [X] and [Y].
When [X] or [Y] is set, [Resolution] is set to [Custom].

7) [Setup Direction]
Not available to GT SoftGOT2000.
Set the installation orientation of the GOT.

• [Horizontal]
• [Vertical]

Some operations of the GOT differ according to the GOT installation orientation.
➟5.1.4 ■3 Operation when the GOT is installed vertically

8) [Color Setting]
Displays the number of display colors of the GOT type selected in [Type].
When [GT2105-Q (320x240)] is selected for [Type], select the number of display colors.
The following shows the items to be selected.

• [65536 Colors]
• [32(Grayscale)]

9) [Graphics Setting]
Not available to GT23 because the setting is fixed to [GOT Graphic Ver.1].
Select a graphics mode.
The following shows the items to be selected.

• [GOT Graphic Ver.2]
• [GOT Graphic Ver.1]

For the details of the graphics modes, refer to the following.
➟5.1.2 Graphics mode ([Graphics Setting])
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10) [Package Folder Name]
Set the name of the folder that stores the package data.
Use up to 32 alphanumeric characters and symbols for the folder name.
For the character strings available and unavailable for folder names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
This item is required for project creation. Always set this item.

11) [Use the gesture function]
Only available to GT27.
Enables the GOT operation by gesture.

➟11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen Gesture Function)
11.13 Operating Objects by the Gesture (Object Gesture Function)

12) [Enable the graphics accelerator to smooth the screen gesture and document display 
operations]
Only available to GT27.

Enables the graphics accelerator for the screen gesture function and the document display.
When the graphics accelerator is enabled, the operations of the screen gesture function and the document 
displaybecome smooth.
Note that the GOT startup time becomes long.

➟11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen Gesture Function)
8.26.3 How to use the document display (for Document Converter output files)

To use the graphics accelerator, install the CoreOS version E or later to the GOT.
➟4.5.3 Installing the BootOS or the CoreOS to the GOT

For how to check the CoreOS version, refer to the following.
➟GOT2000 Series User's Manual (Utility)

13) [Expand base screen sizes]
Available to GT27, GT25, and GS25.

Enables you to set a larger base screen by setting higher resolution than the original GOT resolution.
For details on the base screen size expansion, refer to the following.

➟5.1.3 Base screen size expansion ([Expand base screen sizes])
Click the [Display Setting] button to display the [Display Setting] dialog.
Configure the settings for displaying the scroll bars and navigation window on the GOT.

➟(1) [Display Setting] dialog (Base screen size expansion)

(1) [Display Setting] dialog (Base screen size expansion)

1) [Display the scroll bars]
Displays the scroll bars on the expanded base screens.
Deselecting this item hides the scroll bars and the following items on the screen editors.

• Solid lines representing the scroll bar areas
• Dotted lines representing partitions for GOT screens

2) [Display Timing]
Select the timing for displaying the navigation window.
The navigation window shows your current location within the base screen.

GOT Graphic Ver.1

GOT Graphic Ver.2

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.2

1)

2)

3)
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The window is semi-transparent and one-ninth the size of the GOT screen.
For the details of the window, refer to the following.

➟5.1.3 Base screen size expansion ([Expand base screen sizes])
• [Always]

Always displays the navigation window.
• [While swiping/touching the screen]

Displays the navigation window when you touch somewhere on the screen where no object is displayed or the 
scroll bars.
The window will be hidden one second after you release your finger from the GOT screen.

• [Not display]
Does not display the navigation window.

3) [Display Position]
Set this item when [Display Timing] is set to [Always] or [While swiping/touching the screen].
Select the display position of the navigation window.
The following shows selectable items.

• [Top Left]
• [Top Right]
• [Bottom Left]
• [Bottom Right]

■2 [Language and Font Setting]

1) [Standard Language]
Select the language used in the whole project.
The following shows the items to be selected for GT27, GT25, GT23, GT SoftGOT2000, and GS25.

• [Japanese]
• [English]
• [Chinese (Simplified)]
• [Chinese (Traditional)]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

5)
6)

7)

For GT21-W and GS21-W-N

3)

4)
5 - 28 5. COMMON SETTING
5.1 Changing the GOT Type of the Project ([GOT Type Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

• [Korean (Hangul)]
The following shows selectable items for GT21 and GS21.

• [Japanese]
• [English]
• [Chinese (Simplified)]

2) [Use easily-distinguishable font for 0 (zero) and I]
Use a font having the slashed zero and the crossbar I.

➟1.2.5 ■1 Detailed font specifications
3) [16dot Standard Font]

Available to GT23, GT21, and GS21.
When [Standard Language] is set to [Japanese], [English], or [Korean (Hangul)], select a font of [16dot Standard 
Font].
The following shows the items to be selected.

• [Gothic]
• [Mincho]

4) [Style]
Available to GT2107-W and GS21-W-N.
Select a typeface for the outline font.
The following shows the items to be selected.

• [Gothic]
• [Kaisho]

5) Outline font type
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select the type of an outline font to be used.
The following shows the items to be selected.

• [Alphanumeric/Kana]
• [Kanji]
• [Hangul]

6) [Chinese (Simplified) Character Code]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select a character code used for Chinese (simplified) in the outline font.
The following shows the items to be selected.

• [GB2312]
• [GBK] (fixed for GT SoftGOT2000)

7) [Enable the antialiasing to smooth jagged text edges]
Not available to GT23.
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Enables antialiasing for outline fonts.
Antialiasing smooths out the jagged text on the screen.

As antialiasing is always enabled, no additional setting is required accordingly.

To enable antialiasing, select this item.

GOT Graphic Ver.2

GOT Graphic Ver.1
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■3 [Option Setting]

1) [Check for overlapping objects in the GOT]
Not available to GT21 and GS21.
If objects are overlapped each other, the GOT displays a massage.
If [Adjust object display order in GOT to the one in GT Designer3] is selected, this setting is unavailable.

2) [Adjust object display order in GOT to the one in GT Designer3]
Not available to GT21 and GS21.
Select this item to adjust the display order of the overlapped objects on the GOT to the one in GT Designer3.
If [Check for overlapping objects in the GOT] is selected, this setting is unavailable.
This setting is available for the following screens: base screen, overlap window 1 to 5, superimpose window 1 to 
2,dialog window, and key window.
Example) Displaying the objects overlapped on the same layer with GT Designer3 on the GOT

• When the display order of the objects is adjusted to the one in GT Designer3

• When the display order of the objects is not adjusted to the one in GT Designer3

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

Second placed object (Middle)2

3 Third placed object (Top)

1 First placed object (Bottom)

3
2

1

Display on GT Designer3

The objects are redrawn. 
The display order of the overlapped objects 
on the GOT is adjusted to that of the overlapped 
objects on GT Designer3.

3
2

1
3

2

1
: The object is 
  updated.

1

Only the updated object is redrawn and 
displayed at the top. 
(The display order of the overlapped objects 
on the GOT differs from that of the overlapped 
objects on GT Designer3.)

3
2

1
: The object is 
  updated.

1

3
2

1
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Even if this item is selected, the setting becomes invalid for some objects.
For such objects, refer to the following.

➟5.1.4 ■5 Precautions for the object stacking order adjustment setting
For the details of superimposition of objects or figures, refer to the following.

➟6.5.4 Common setting for figures

As the object stacking order adjustment is always enabled, no additional setting is required accordingly.

To enable the object stacking order adjustment, select this item.
3) [Use system labels in conjunction with MELSOFT Navigator]

System labels can be used according to device settings of GT Designer3.
For the system label setting, refer to the following.

➟6.1.3 How to set system labels
Clear this item when a system label is not used.
When this item is cleared, the system label update/check is executed.
When no error occurs, a system label is converted to a device name to which the system label is assigned.
When any error occurs, a system label is not converted to a device name to which the system label is assigned.
Therefore, this item is not cleared.
Check or modify the system label setting, and clear this item again.

GOT Graphic Ver.2

GOT Graphic Ver.1
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5.1.6 [Output] window

This window displays operation histories that significantly affect the project in a list.
This window appears at the GOT type change.
To display this window manually, select [View] → [Docking Window] → [Output] from the menu.

1) [Option] button
Displays the option operations for the history list.

2) [Refinement]
Use this field to refine the messages displayed on the history list by keywords.

3) History list
Displays the history of operations that significantly affect the project, such as the GOT type change or import of 
other projects, in a list.

➟12.13.2 Specifications of the project conversion from GOT1000 to GOT2000

Item Description

Export Exports the history list as a CSV file or Unicode text file. After clicking the item, specify the 
storage folder, file name, and file type.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])
5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
5.2.3 Setting dialog windows ([Dialog Window])
5.2.4 Setting key windows ([Key Window])
5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])
5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
5.2.7 Configuring the security settings for the GOT screen ([Screen Security] (Operator authentication))
5.2.8 Configuring the security settings for the GOT screen ([Screen Security] (Level authentication))
5.2.9 Configuring the security settings for operations in the utility ([Functional Operation Security])
5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])
5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
5.2.12 Configuring the settings for retaining GOT internal device data at power failure ([Internal Device 
Retention])
5.2.13 Configuring the settings to convert a text into kanji or Simplified Chinese characters in the GOT 
([Kana-Kanji/Pinyin Conversion])
5.2.14 Setting a screen to be displayed on the GOT at startup ([Startup Logo])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/
Window])

➟■1 Specifications of the screen switching
■2 How to use the screen switching
■3 Moving an overlap window
■4 Precautions
■5 [Screen Switching/Window]

The GOT displays or switches the screens with screen switching devices.
The screens to be displayed on the GOT are switched by changing a value (screen number) of the screen switching 
device.
Example 1) Setting D100 for the screen switching device of a base screen

Example 2) Setting D200 for the screen switching device of the overlap window 1

■1 Specifications of the screen switching

(1) Target screens of the screen switching device
Set a screen switching device for each of the following screens.

• Base screen
• Overlap window 1 to 5

(Overlap window 1 and 2 for GT23, GT21, and GS21)
• Superimpose window 1, 2
• Dialog window
• Mobile screen (GT27, GT25, GT SoftGOT2000, and GS25)

For switching mobile screens, refer to the following.
➟10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100: 10 D100: 20

The device value of D100
 is changed. (10 to 20)

Base screen 
(screen number: 10)

Base screen
 (screen number: 20)

The GOT displays a base screen 
whose screen No. is the same as 
the value of the screen switching device.

Line A status

D200: 0 D200: 10

The value of D200 is 
changed. (0 to 10)

Window screen 
(screen number: 10)

Window screen: 10 Window screen: 20

Window screen 
(Not displayed)

D200: 20

The value of D200 is 
changed. (10 to 20)

Window screen 
(screen number: 20)

The GOT displays a window screen 
whose screen No. is the same as 
the value of the screen switching device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Screen switching of base screens
The GOT displays a base screen whose screen No. is the same as the value of the screen switching device.
Example) Storing 20 in the screen switching device (D100) while displaying the base screen whose screen No. is 10

When the screen switching device stores 0, the response differs depending on the setting of [Retain the displayed screen 
when the base screen No. changes to 0 (GT10 series compatible function)] in the [Environmental Setting] window.

➟■5 [Screen Switching/Window]
If [Retain the displayed screen when the base screen No. changes to 0 (GT10 series compatible function)] is deselected, 
the GOT displays the lowest numbered base screen.
Example) Storing 0 in the screen switching device (D100) when the lowest screen No. is 1

If this item is selected, the base screen is not switched.
Example) Storing 0 in the screen switching device (D100) while the GOT displays base screen No.10

If the screen number which does not exist is stored in the screen switching device, the system alarm is displayed.
In that case, the screen is not switched.
Example) Storing the screen No.50 of the base screen which does not exist in the screen switching device (D100)

D100: 10 D100: 20

The device value of D100 
is changed. (10 to 20)

Base screen 
(screen number: 10)

Base screen 
(screen number: 20)

The GOT displays a base screen 
whose screen No. is the same as 
the value of the screen switching device.

Line A status

D100: 10 D100: 0

The device value of D100 
is changed. (10 to 0)

Base screen 
(screen number: 10)

Base screen 
(screen number: 1)

The GOT displays a base screen 
whose screen No. is the minimum.

Line A status

Line A status

D100: 10 D100: 0

The device value of D100 
is changed. (10 to 0)

Base screen 
(screen number: 10)

Base screen 
(screen number: 10)

The base screen is not switched.Line A status

Line A status

D100: 10 D100: 50

The device value of D100 
is changed. (10 to 50)

Base screen 
(screen number: 10)

Base screen 
(screen number: 10) The GOT displays the 

system alarm. 
The base screen is not 
switched.Line A status
5. COMMON SETTING
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(3) Screen switching of overlap windows and superimpose windows
The GOT displays the window screen whose screen No. is the same as the value of the screen switching device as an 
overlap window or a superimpose window.
Example 1) Setting D100 for the screen switching device of an overlap window

When the screen switching device stores the value set to [Screen No. of the window screen to be hidden] in [Environment 
Setting] dialog, the GOT closes the target overlap window or superimpose window.

➟■5 [Screen Switching/Window]
Example)
Storing 0 in the screen switch device (D200) while displaying the overlap window 1
([Screen No. of the window screen to be hidden]: 0)

If the screen number which does not exist is stored in the screen switching device, the system alarm is displayed.
In that case, the screen is not switched and the window which has been displayed remains displayed.
Example)
Storing the screen No.50 of the window screen which does not exist in the screen switching device (D200)

(4) Screen switching of dialog windows
For the details of dialog windows, refer to the following.

➟5.2.3 Setting dialog windows ([Dialog Window])

D200: 0 D200: 10

The value of D200 is
changed. (0 to 10)

Window screen 
(screen number: 10)

Window screen: 10 Window screen: 20

Window screen 
(Not displayed)

D200: 20

The value of D200 is 
changed. (10 to 20)

Window screen 
(screen number: 20)

The GOT displays a window screen 
whose screen No. is the same as 
the value of the screen switching device.

D200: 10 D200: 0

The device value of D200 
is changed. (10 to 0)

Overlap window 1 
(screen number: 10)

The GOT closes 
the overlap window 1.

Window screen 10D200: 10 D200: 50

The device value of D200 
is changed. (10 to 50)

The GOT displays 
the system alarm.

Window screen 10

The window which has 
been displayed remains 
displayed.
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■2 How to use the screen switching

(1) Switching screens with the screen switching device
When a screen number is stored in the screen switching device, the corresponding screen is displayed on the GOT.
Example) Storing 5 in the screen switching device (D100)

Set the screen switching device in the [Screen Switching/Window] dialog.
➟5.2.1 ■5 [Screen Switching/Window]

(2) Switching screens with touch switches (Go To Screen switch)
The screen is switched to another screen when you touch the Go To Screen switch placed on the screen.
The destination screen depends on the setting of the touch switch.
For how to set the Go To Screen switch, refer to the following.

➟8.2.7 [Go To Screen Switch] dialog

(a) Switching screens by specifying a screen number
The screen can be switched to the base screen or the window screen which is set for the touch switch.

(b) Switching screens according to the hierarchy or history of the screens
The screens can be switched according to the operation (hierarchy mode/history mode) which is set for the touch switch.

• Hierarchy mode
This mode is for returning to a screen in the upper hierarchy according to the screen hierarchy based on the relation 
of a source screen and a destination screen.

• History mode
This mode is for returning to the previously displayed screen according to the history of the screen switching.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100: 0 → 5

348BA1254
Production status screen 1

The GOT displays 
the base screen 
with the screen number 5.

348BA1254
Production status screen 1

Touch the Go To Screen 
switch with the screen 
number 5.

The GOT displays 
the base screen with 
the screen number 5.

Line No. 1
A 1254

B 348

A 1254

B 348

1. 2.

3.

Upper hierarchy Lower hierarchy

Base screen 1 Base screen 2 Base screen 3

4.5.
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(3) Selecting a screen switching device
To select a device used as the screen switching device, refer to the following depending on the method of screen 
switching.

(a) GOT internal device
Recommended for performing the screen switching by touch switches.
To control the screen switching by a controller, you need to use scripts or the device data transfer.

(b) Controller device
Recommended for controlling the screen switching by a controller.
You can also switch the screens with touch switches.

(4) Display position of an overlap window or a superimpose window
You can specify the display position of an overlap window or a superimpose window by setting [Window Position] on a 
base screen.
However, when you switch a base screen on which a window screen is being displayed, note the following: Even if you 
configure different [Window Position] settings on the destination base screen, the window screen remains in the same 
position after the base screen switching.
On the base screen having no [Window Position] setting, the display position of a window screen is as follows.

• A window screen initially appears in the center of the GOT screen.
• When a window screen has been displayed before, the window screen appears at the previously displayed position.

For how to set [Window Position], refer to the following.
➟8.30 Specifying the Display Position of a Window Screen

(5) Using an overlap window as the system window
System window includes test windows, remote screens of the remote personal computer operation (Ethernet), and 
window screens which are used for system applications.
Use the system window by assigning any overlap window.
You can also display the window screen with an overlap window for which the system window is assigned when the 
system window is not used.
If the system window is called while a window screen is displayed with the overlap window, the GOT closes that window 
screen and opens that system window.
After the system window is closed, the window screen whose screen No. is the same as the value of the screen switching 
device is displayed again.
Example) Switching between a system window and a window screen
(Overlap window 1 is used as the system window and D200 is set for the screen switching device.)

Assign system windows in the [Screen Switching/Window] dialog.
➟5.2.1 ■5 [Screen Switching/Window]

Line No. 1
A 1254

B 348

A 1254

B 348

1. 2.

3.

Base screen 1 Base screen 2 Base screen 1

4.
5.

Window screen 10 
(overlap window 1)

Touch the touch switch for 
starting the test window.

D200: 10

VALUE16SET/RST

SET VAL VALUE32

BM VAL16

BM VAL32

ChNo.[1]NetNo.[  0]ST [FF]CPUNo.[0]

Test window 
(overlap window 1)

The GOT closes the displayed window 
screen and opens the system window.

D200: 10

After the system window is closed, 
the GOT opens the overlap window 1 
of the screen switching device value.

D200: 10

Window screen 10
 (overlap window 1)
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(6) Displaying an overlap window off-screen
Not available to GT21 and GS21.
To display an overlap window off the GOT screen, select [Display windows beyond the screen area] in the [Screen 
Switching/Window] dialog.
Note that dialog windows cannot be displayed off the GOT screen.
The overlap window can be displayed off the right side or the bottom of the screen.

➟5.2.1 ■5 [Screen Switching/Window]

This setting also allows the following windows to be displayed off the GOT screen.

○: Displayable, ×: Not displayable

Window type
Graphics mode

GOT Graphic Ver.2 GOT Graphic Ver.1

Key window ○ ○

Comment window ○ ○

Recipe operation window ○ ○

[Bookmark] window ○ ○

Screen image of the operation log ○ ○

Personal computer screen on the GOT during remote personal computer 
operation (Ethernet) ○ ×

Window used for each function

iQSS Utility ○ ○

Drive recorder ○ ○

CC-Link IE TSN/CC-Link IE Field Network 
diagnostics ○ ○

System launcher ○ ○

System Launcher (Servo Network) ○ ○

Servo amplifier graph ○ ○

File Manager ○ ○

File Print ○ ○

Network drive setting ○ ○

When [Display windows beyond the screen area] 
is deselected

When [Display windows beyond the screen area] 
is selected

Moving an overlap 
window
5. COMMON SETTING
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(7) Specifying the stacking order of overlap windows
Not available to GT21 and GS21.
To specify the stacking order of overlap windows, set [Specify the display order] in the detail setting for each overlap 
window.
The detail setting for the overlap window is configurable in the [Environmental Setting] window ([Screen Switching/
Windows]).

➟■5 [Screen Switching/Window]
The stacking order number for an overlap window is settable ranging from 1 (Front) to 5 (Back).
The same stacking order number is settable for multiple overlap windows.
When an overlap window is set to be used as a system window, the user-specified stacking order number is invalid.

When you specify the stacking order number for some overlap windows, all overlap windows are classified into groups 
below.

• User-specified stacking order group (Overlap windows having a user-specified stacking order number)
• Non-user-specified stacking order group (Overlap windows having no user-specified stacking order number)
• Group of overlap windows used as system windows

Within the user-specified stacking order group, the overlap windows always appear in the specified stacking order.
Within the other groups, the stacking order of the overlap windows varies with the user operation or GOT behavior.
The following shows examples where the overlap windows in the multiple groups are displayed.

• Example 1) When touching an overlap window having a user-specified stacking order number

• Example 2) When touching an overlap window having no user-specified stacking order number

Overlap window 
having no user-specified 
stacking order number

Stacking order 
number: 2

Stacking order 
number: 1

User-specified 
stacking order group

Stacking order 
number: 2

Stacking order 
number: 1

Overlap window 
having no user-specified 
stacking order number

User-specified 
stacking order group

The user-specified stacking order 
group appears in the front while 
the overlap windows in the group 
are stacked in the specified order.

Touch

Overlap window 1

Overlap window 2

Non-user-specified 
stacking order group

User-specified 
stacking order 
group

User-specified 
stacking order 
group

Overlap window 2

Non-user-specified 
stacking order groupOverlap window 1

The non-user-specified stacking order group 
appears in the front, and the stacking order 
within the group is also changed.

Touch 
overlap window 1.
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(8) Disabling the touch operation on the screens that are behind an overlap window
Not available to GT21 and GS21.
To disable the touch operation on the screens that are behind an overlap window, select [Disable the touch operation of 
a screen on the back] in the detail setting for the overlap window. The overlap window appears in the front, regardless of 
the stacking order number setting.
While this overlap window is being displayed, the touch operation is disabled in the area outside the window.

• Example) When disabling the touch operation on the screens that are behind overlap window 1

The detail setting for the overlap window is configurable in the [Environmental Setting] window ([Screen Switching/
Windows]).

➟■5 [Screen Switching/Window]
A bit device is usable to enable or disable the touch operation.
When this bit device control is used, the touch operation is disabled while the relevant bit device is on.

(9) Changing the action of the system window when the base screen is switched
Use GS522.b7 to set the action of the system window displayed when the base screen is switched.

• When GS522.b7 is on
The displayed system window is closed when the base screen is switched.

• When GS522.b7 is off
The displayed system window is not closed when the base screen is switched.

Overlap window 2

Overlap window 3

Overlap window 1

Touch operation 
enabled

Touch operation 
disabled

Touch operation 
disabled

Base screen
Touch operation 

disabled

348BA1254

Production status screen 1

VALUE16

SET VAL VALUE32

BM VAL16SET/RST

ChNo.[1]NetNo.[ 0]ST [FF]CPUNo.[0]

BM VAL32

Touch the switch.

Base screen 1 Base screen 2

System window

The system window is closed 
and the base screen is switched.
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For system windows, refer to the following.
➟(5) Using an overlap window as the system window

■3 Moving an overlap window

The following shows how to move an overlap window which is displayed on the GOT.

(1) Moving the window with touch operations
Touch the title bar of an overlap window, and then touch the position to move the window to within three seconds.
To enable this operation, the setting for displaying title bars must be configured.

(2) Moving the window with a slide operation
While touching the title bar of an overlap window, slide the window to its destination.
To enable this operation, the setting for displaying title bars must be configured.

348BA1254
生産状況画面1

VALUE16

SET VAL VALUE32

BM VAL16SET/RST

ChNo.[1]NetNo.[ 0]ST [FF]CPUNo.[0]

BM VAL32

VALUE16

SET VAL VALUE32

BM VAL16SET/RST

ChNo.[1]NetNo.[ 0]ST [FF]CPUNo.[0]

BM VAL32

Base screen 1 Base screen 2

Touch the switch.

System window

The base screen is switched 
with the system window displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Touch a point to move
 within 3 seconds.

2.

Touch the title 
bar.

1.

While touching the title bar, 
slide the window to its destination.

2.

Touch the title 
bar.

1.
5 - 42 5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

(3) Moving the window with devices
Set the coordinates of a position to move the window for the display position specification device (X and Y).
To enable this operation, the setting of the display position specification device must be configured.

➟■5 [Screen Switching/Window]

■4 Precautions

(1) Applications of the device which is set for the screen switching device
Use the device which is set for the screen switching device carefully.
A careless installing to the device may cause unexpected screen switching.

(2) Number of overlap windows used as system windows
The GOT can use the following overlap windows as system windows.

• Overlap window for which no screen switching device is set
• Overlap window for which [Use also as a system window] is set

The number of system windows cannot exceed that of these overlap windows.
Set as many such overlap windows as the number of system windows to be used.

(3) Displaying an overlap window off-screen with display position specification devices
When selecting [Display windows beyond the screen area] in the [Screen Switching/Window] dialog, you can move an 
overlap window off-screen by specifying the window coordinates outside the GOT screen area with display position 
specification devices.
The off-screen window is not movable by the touch operation.
To move the window back into view, specify the window coordinates within the screen area with display position 
specification devices.

(4) Detail setting for the overlap window
In the detail setting for an overlap window, if you select [Disable the touch operation of a screen on the back] and deselect 
[Display the title bar], make sure to place a touch switch for closing the overlap window.

➟8.2.7 [Go To Screen Switch] dialog
Otherwise, you cannot close the overlap window.

The window is displayed 
at the position (X: 10, Y: 15).

Screen switching device 
Display position specification device (X) 
Display position specification device (Y)

: GD100 = 1 
: GD101 = 10 
: GD102 = 15

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■5 [Screen Switching/Window]

Set the screen switching and the display method of window screens.
Select [Common] → [GOT Environmental Setting] → [Screen Switching/Window] from the menu to display this dialog.

1) Screen switching device for a base screen
Set a screen switching device for a base screen.
Only a word device can be used for the screen switching device.

➟6.1.2 How to set devices
2) Settings of overlap window 1 to 5

Set whether to use overlap window 1 to 5, the screen switching devices, and the display method of those windows.
The overlap window which you selected becomes available.

Item Description

[Screen Switching Device]
Set screen switching devices for overlap window 1 to 5.
Only a word device can be used for the screen switching device.

➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

5)

3)

6)

7)
8)

9)
10)

11)

14)

13)
12)

15)
16)

4)
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[Display Position]

Specify the display positions of overlap window 1 to 5 with devices.
A display position specification device is automatically assigned to each overlap window 
when you select this item.
The device numbers of the display position specification devices for the X and Y 
coordinates are specified as follows: The horizontal coordinate (X coordinate) is the screen 
switching device + 1, and the vertical coordinate (Y coordinate) is the screen switching 
device + 2.
Specify the display positions of overlap window 1 to 5 as follows.

If a value which cannot be displayed on the GOT is stored to the display position 
specification device, the display position is adjusted automatically.
The adjusted display position is not reflected to the device value.

[Use also as a system window]
Allows to use an overlap window as the system window.

➟5.2.1 ■2 How to use the screen switching

[Detail Setting]

Displays the [Detail Setting] dialog.

• [Close the window when switching base screens]
Closes the overlap window when the base screen is switched.

• [Display the title bar]
Displays a title bar on the overlap window.

• [Specify the display order]
Select a stacking order number for the overlap window.
The setting range is [1 (Front)] to [5 (Back)].
For the details of the stacking order, refer to the following.
➟5.2.1 ■2 (7) Specifying the stacking order of overlap windows
• [Disable the touch operation of a screen on the back]

Displays the overlap window in the front regardless of the setting of [Specify the display 
order], and disables the touch operation on the screens behind the overlap window.
Select this item, and then select a condition for disabling the touch operation.
• [Always disable]: Always disables the touch operation.
• [Device control]: Uses a specified bit device to enable or disable the touch operation.
For the details, refer to the following.
➟5.2.1 ■2 (8) Disabling the touch operation on the screens that are behind an overlap 

window

Item Description

Display position specification device 
(Y coordinate) 

(screen switching device + 2)

Display position specification 
device (X coordinate) 
(screen switching device + 1)

Adjust

Adjusted display position

Position specified by the display 
position specification device value
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3) [Output a window screen via HDMI/RGB]
Available to GT27 models excluding GT2705-V.
A selected overlap window is output to an external device using HDMI/RGB connection.
Select this item and then select an overlap window to be output to the external device.
The selected overlap window is not displayed on the base screen.
For the details, refer to the following.

➟10.10 Displaying the GOT Screen on an External Display (Video Output Function)
4) [Take a hard copy of a screen other than the displayed monitor screen]

Available to GT27, GT25, and GS25.
To produce hard copy output of a screen other than the displayed monitor screen using the hard copy function, 
select one overlap window as the resource.
The selected overlap window is unavailable to specify the display position or as a system window.
Select this item, and then select an overlap window from the list.
Selectable overlap windows are overlap windows 1 to 5 whose use is deselected.
For the details on hard copy, refer to the following.

➟9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard Copy])
5) Setting of superimpose window 1 and 2

Set whether to use superimpose window 1 and 2 and the screen switching device.
The superimpose window which you selected becomes available.

6) Setting a dialog window
Set whether to use the dialog window and the screen switching device.
The dialog window which you selected becomes available.

7) [Screen Switching Device Data Type]
Set the data type of the screen switching device.

• [BIN]: Signed 16-bit binary or unsigned 16-bit binary
• [BCD]: 16-bit binary coded decimal

8) [Specify the screen No. of a base screen to be displayed at the time of GOT activation]
Set a screen number of the base screen to be displayed on the GOT at startup.

9) [Screen No. of the window screen to be hidden]
Set a screen number for closing a displayed overlap window or superimpose window.

10) [Disable background colors of overlay screen when setting an overlay screen]
Disables the background color of the called screen.

11) [Overlay Screen Positioning]
Select the position of the called screen.

12) [Cancel automatic screen save when switching screens]

[Output a window screen via HDMI/RGB] Only available to GT27.
A selected overlap window is output to an external device using HDMI/RGB connection.
Select this item and then select an overlap window to be output to the external device.
The selected overlap window is not displayed on the base screen.
For the details, refer to the following.

Item Description

[Screen Switching Device]
Set screen switching devices for superimpose window 1 and 2.
Only a word device can be used for the screen switching device.

➟6.1.2 How to set devices

[Detail Setting]

Displays the [Detail Setting] dialog.

• [Close the window when switching base screens]
Closes the superimpose window when the base screen is switched.

Item Description

Screen switching device
Set a screen switching device for a dialog window.
Only a word device can be used for the screen switching device.

Item Description
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Cancels the screen save mode when the screen is switched.
13) [Enable screen switching by device while the screen is being touched]

Not available to GT21 and GS21.
Enables screen switching by using the screen switching devices while the screen is being touched.

14) [Screen switching operation]
Set the operation of the Go To Screen switch.

15) [Display windows beyond the screen area]
Enables overlap windows and key windows to be displayed off the GOT screen.

➟5.2.1 ■2 (6) Displaying an overlap window off-screen
　 5.2.4 ■2 (3) Displaying a key window off-screen

16) [Retain the displayed screen when the base screen No. changes to 0 (GT10 series compatible 
function)]
When the screen switching device stores 0, the currently displayed base screen is not switched.
If base screen No.0 exists, the current screen is switched to base screen No.0.
If this item is deselected, the GOT displays the lowest numbered base screen.

➟5.2.1 ■1 (2) Screen switching of base screens

Item Description

[Operation Timing]

For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Set the timing to operate the Go To Screen switch.
Select [When a finger is lifted (OFF synchronous)] to switch screens at the timing when you 
release your finger from the switch.
Select [When a finger is touched (ON synchronous)] to switch screens when you touch the 
switch.
For GT21 and GS21
The screen is switched when you touch the switch.

[Back Screen Switching]

Set the operation for when [Back (Previous/History)] is selected for [Next Screen] in the 
setting of the Go To Screen switch.
Select [Previous] to perform the screen switching in the hierarchy mode.
Select [History] to perform the screen switching in the history mode.

➟5.2.1 ■2 (2) (b) Switching screens according to the hierarchy or history of the screens

[Store history to the memory card]
Stores the history of the screen switching in the data storage.
This item can be selected if [History] is selected for [Back Screen Switching].
5. COMMON SETTING
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5.2.2 Setting for switching the language displayed on the GOT ([Language 
Switching])

➟■1 Specifications of the language switching
■2 How to use the language switching
■3 Precautions
■4 [Language Switching]

The GOT switches comments displayed on the object according to a value (column No. of the comment group) in the 
language switching device.
If messages of Japanese, English, Chinese, and other languages are registered in each column of the comment group, 
the language of the comment displayed can be switched.
For how to register comments, refer to the following.

➟5.8.2 How to use comment

On the other hand, the system language used in the utility screen and others is switched by the system language 
switching device.
The system language can be switched to the language compatible with the language ID according to the value stored to 
the system language switching device (language ID).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

非常停止リミット作動
Emergency stop limit 
switch operated.

Comment display (word) 
(specifies a comment No.)

Language switching device 
(specifies a column No.)

D100 1 D100 2 D100 2 

D200 1 D200 1 D200 2 

A ライン供給コンベア停止

レシピファイルが異常です。 
レシピファイル内容を確認して下さい。

GD100 = 1

The recipe file is faulty.
Check the file contents.

GD100 = 2

System language switching device: GD100 
Language ID = 1: Japanese, 2: English
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■1 Specifications of the language switching

(1) Language switching device
The language switching device is used to switch the comment column of the comment group.
A language switching device can be set per project.
A word device whose data type is signed BIN 16 is available.
Store the column No. of the comment group to the language switching device to switch the comment column to be 
displayed.
For the setting of comments, refer to the following.

➟5.8 Comment Setting ([Comment])
For the setting of the language switching device, refer to the following.

➟5.2.2 ■4 [Language Switching]

(2) System language switching device
The system language switching device is used to switch the system language used for the utility, system alarm, and 
others.
A system language switching device can be set per project.
A word device whose data type is signed BIN 16 is available.
Language IDs are allocated to each language.
Store the language ID to the system language switching device to switch the system language.
By default, language IDs are allocated as shown below.

When a value other than the one above is stored to the system language switching device, the system language set in 
the utility is set.
For the setting of system language switching, refer to the following.

➟5.2.2 ■4 [Language Switching]

(3) Area setting
The formats of a sorting order of the date, decimal marker, and others which differ depending on areas can be switched 
associating with language switching.
This setting is applied to all the objects on the user screen.
However, this setting is not applied to the system screens, such as the utility screen and the system application screen.

(a) Date
Select [yy/mm/dd], [mm/dd/yy], or [dd/mm/yy] for a sorting order of the date.

(b) Decimal marker
Select [, (comma)] or [. (period)] for a decimal marker.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Language ID Compatible language

1 Japanese

2 English

3 Chinese (Simplified)

4
Chinese (Traditional)
Not available to GT21 
and GS21.

5
Korean
Not available to GT21 
and GS21.

6 to 10 Not set
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■2 How to use the language switching

(1) Switching the language of the comment to be displayed on the object (switching the comment 
column)
Switch the comment column to switch the language of the comment to be displayed on the object.
Store the column No. to the language switching device to switch the comment column.

(a) Setting procedure

Step 1 Set the comment group.
Set multiple comment columns in the comment group.

➟5.8.2 How to use comment
Step 2 Set the language switching device.

➟5.2.2 ■4 [Language Switching]
Step 3 Configure the setting of each object on the screen for displaying character strings set as a comment text.

➟8.2 Placing a Touch Switch
8.3 Placing a Lamp
8.7 Placing a Comment Display
8.10 Placing a Historical Data List Display
8.11 Placing an Alarm Display
8.12 Placing a Simple Alarm Display

(b) Operation on the GOT
Store the value of the column No. to the language switching device by a touch switch or a numerical input.
Storing the value switches the language of the comment to be displayed on the object.
When the value of the language switching device is out of the range (0, 31 or larger) or the column No. which does not 
exist is specified, a comment is not displayed.
However, when [Alternative Display (when the language switching device value is out of the range (1-30) or comment 
column No. does not exist)] is set, the column No. set previously is displayed.

(2) Switching the system language on the user-created screen
The system language is used on the screen other than the user-created screen, such as the utility screen and system 
alarm.
To change the system language on the user-created screen, use the system language switching device.
Store the value of the language ID to the system language switching device to switch the system language.
You can also change the system language on the utility screen of the GOT.
For how to change the system language on the utility screen, refer to the following.

➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

確認

確認 Confirm

Column No. 2Column No. 1Comment No.

: :

1

2

3

中止 Stop
Text setting of the object 
Display comment No. 2.

Set the object.3.

2.

Language switching device 
D100 = 1

Set the language switching 
device.

1. Set the comment group.
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(a) Setting procedure
Step 1 Enable language switching to set the system language switching device.

➟5.2.2 ■4 [Language Switching]
Step 2 Set the language ID to be allocated to the system language when required.

➟5.3.1 ■2 [Display Setting/Language Setting]
Step 3 Place an object such as a numerical input or a word switch for storing the language ID to the system 

language device.

(b) Operation on the GOT
Input the value of the language ID to the language switching device by a touch switch or a numerical input.
Inputting the value switches the system language to the language which is compatible with the language ID.
For the specifications of the language ID, refer to the following.

➟5.2.2 ■1 (2) System language switching device
The system language can be switched by the system language switching device only on the user-created screen.
The system language of the system window, the utility screen, the extended function screen, or other screens cannot be 
switched by the system language switching device while the screen is displayed.
Switch the system language by the device after closing all the screens above.

■3 Precautions

(1) Effect of language switching or system language switching on objects
Language switching or system language switching switches screens.
Therefore, the operations of the following objects are affected at language switching.

(a) Scatter graph
When settings such as memory storage are not configured, the previously collected data of the occurrence time or others 
is deleted.
To store the previously collected data at language switching, set each object to store the memory.

➟8.20.4 ■4 [Extended] tab

(b) Parts movement
When a locus is displayed, the locus is deleted.

(c) Display trigger of objects
When the display trigger condition of objects is not satisfied before language switching, the description displayed on 
objects is deleted.

(d) Alarm display, Simple alarm display
When the display is scrolled, the display returns to the top after language switching.

(e) Input object
When the data is being input to objects, the cursor is deleted and the input is canceled.

(2) Restrictions at system language switching
(a) System language switching while a dialog window is displayed

When the system language is switched while a dialog window is displayed, the system language is switched after the 
dialog window is closed and the screen returns to the user-created screen.

(b) System language switching when the SFC monitor or the ladder editor is used
If the SFC monitor or the ladder editor is finished with a user-created screen displayed and GT Designer3 is started again 
with the system language different from the one of the previous run, the program displayed before the system language 
switching may not be acquired.
In that case, a system alarm occurs.
However, if only alphanumeric characters are used for the file name of the project to eliminate the difference between the 
text codes of the file names before and after the system language switching, the system alarm does not occur.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(c) System language switching in an operation log
When all the following settings are applied and an operation log file is converted, the operation log file is converted in the 
system language set in the utility.
(The file is not converted in the language specified by the system language switching device.)

• Set [System Language Switching Interlock] for [File Conversion Language].
• Use a file convert trigger or the auto conversion at log file switching.

For the operation log settings, refer to the following.
➟5.2.11 ■5 (3) [File Conversion] tab

(d) Language switching at alarm log file conversion
When the file conversion language is set to [System Language Switching Interlock] and an alarm log file is converted by 
the file convert trigger, the file is converted in the system language set in the utility.
(The file is not converted in the language specified by the system language switching device.)
For the setting of the alarm log file conversion, refer to the following.

➟9.1.2 ■5 [Alarm Common Setting] dialog

■4 [Language Switching]

In [Language Switching], the language switching device and the system language switching device are set.
Select [Common] → [GOT Environmental Setting] → [Language Switching] from the menu to display this window.

1) [Use Language Switching]
Select this item to enable language switching.
Set language switching.

2) [Language Switching Device]
Set the language switching device.
A word device whose data type is signed BIN 16 can be set.

3) [Alternative Display (when the language switching device value is out of the range (1-30) or 
comment column No. does not exist)]
When the comment column No. which matches with the value of the language switching device does not exist in 
the comment group, select whether to display a comment.
The following shows the items to be selected.

• [Not display]
Comments are not displayed.

• [Display]
A comment is displayed.

After selecting this item, set the comment column No. to be displayed to [Comment Column No.].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

6)

5)

4)

3)
2)
5 - 52 5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

When the comment column No. which does not exist is set at this time, a comment is not displayed.

4) [Comment column No. to be previewed on the editor]
Set the comment column No. to be used for a preview display on the screen editor.

5) [Region Setting]
Set the formats of a sorting order of the date, decimal marker, and others which differ depending on areas.

6) [Use System Language Switching]
Select this item to enable system language switching.
Set the system language switching device.
When the language ID setting is required, click the [System Language Setting] button to set the language ID.

Item Description

[Comment Column No.] The setting range is [1] to [30].

Item Description

[Standard] Set the row with [*] as the default value of the area setting.

[Comment Column No.]
Set the comment column No. which the area setting is applied to.
The setting range is [1] to [30].

[Remark (Region Name)] Set the remarks such as the area setting name. Up to 32 characters can be set.

[Date Format]

Select a sorting order of the date.
The following shows the items to be selected.
• [yy/mm/dd]
• [mm/dd/yy]
• [dd/mm/yy]

[Decimal Marker]

Select a symbol to be used as a decimal marker.
The following shows the items to be selected.
• [, (comma)]
• [. (period)]

[New] button Adds a new area setting.

[Delete] button Deletes a selected area setting.

[Delete All] button Deletes all the area settings.

Item Description

[System Language Device]
Set the system language switching device.
A word device whose data type is signed BIN 16 can be set.

[System Language Setting] button

Displays the settings of the language ID to be used for system language switching.
The system language setting can be displayed only when [Language Setting] is set in the 
GOT setup.

➟5.3.1 ■2 [Display Setting/Language Setting]
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5.2.3 Setting dialog windows ([Dialog Window])

➟■1 Specifications of dialog windows
■2 How to use dialog windows
■3 Precautions
■4 [Dialog Window...]

You can create and replace system messages displayed on the GOT using the created dialog windows.
Example 1) Displaying a created dialog window as a new message
By creating a dialog window for an error or warning as a system, the GOT can display the dialog window as a system 
message.
You can set a window that does not display the next screen without an answer to the message or a window that is for 
confirmation for the information.

Example 2) Displaying a created dialog window instead of the system message of the GOT
You can replace the system message displayed by the GOT with the created dialog window.
The GOT can display more specific and system-matched massages.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Target setting screen

A dialog window such as guiding a user 
to confirm the operation can be displayed.

Actual
500 488
300 225

Target
Line A
Line B

Target change

Target Actual
500 488
300 225

Line A
Line B

Target change

500
300

Line A
Line B

Back

You are going to cancel 
the present target 
and set a new target.
Are you sure?

NOYES

Changed to the dialog window created by a user

The input value is beyond the range.
Input a correct value.

System message displayed on the GOT

Production status screen 1

Production status screen 1
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■1 Specifications of dialog windows

(1) Available screen size and number of screens
For the specifications of dialog windows as window screens, refer to the following.

➟1.2.3 ■2 Screen specifications

(2) Available figures and objects
You can place all the figures and objects placeable on the window screen.
Some restrictions are placed on the use of the following objects.

(3) Superimposition of objects
The superimposition of objects is not available.

(4) Layer setting
The front layer and the back layer are combined on the GOT.
The set object stacking order may be invalid.

(5) Screen script and trigger action
The screen scripts and trigger actions set in the dialog window do not run.

(6) Screen switching while a dialog window is displayed

Screen switching is available while a dialog window is displayed.

The screen is not switched while a dialog window is displayed.
If you have attempted to switch the screen, the screen switching is valid after the dialog window is closed.

(7) Priority between the displayed dialog window and a newly generated system message
A system message and a dialog window cannot be displayed together.
If you have attempted to display a dialog window together with a system message, the system message has the priority.

(a) When a user-created system message is generated while a dialog window is displayed
The displayed dialog window remains.
The newly generated system message is not displayed.

(b) When a system message of the GOT is generated
The displayed dialog window is closed, and 0 is stored in the screen switching device for the dialog window.
Then, the newly generated system message is displayed.
If a button is arranged on the displayed dialog window, the following processing is executed before the window is closed.

• For the dialog window with only a [OK] button, the processing is the same as when the [OK] button is pressed.
• For the dialog window with a cancel button, the processing is the same as when the [Cancel] button is pressed.

(8) Dialog window replacement setting on superimpose windows or called screens
On the screen as a superimpose window or called screen of the set overlay screen, screen-based dialog window 
replacement setting is invalid.
The dialog window replacement setting of the displayed base screen is valid.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Object Restriction

Numerical input, text input The input operation is not available.

Recipe display (record list) The object is not displayed.

Key window object

The key window object is displayed only on the dialog window that appears instead of any of the following 
system messages.
• [Input data error, too many integer places]
• [Input data error, too many decimal places]
• [Input data error, number too large/small]
• [Input data error, out of range]
• [Do you want to change?]
For the system message replacement display, refer to the following.

➟5.2.3 ■2 (2) Displaying a created dialog window instead of the system message of the GOT

GOT Graphic Ver.2

GOT Graphic Ver.1
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■2 How to use dialog windows

To use a dialog window, set a screen switching device for the dialog window.
For how to set the screen switching devices, refer to the following.

➟5.2.1 ■5 [Screen Switching/Window]

(1) Displaying a created dialog window as a new message
Storing the screen number of the created dialog window to the screen switching device enables the display of the dialog 
window.
Storing 0 to the screen switching device closes the displayed dialog window.
Example)
Storing the screen number of the window screen 20 to the screen switching device (D300) for the dialog window

(2) Displaying a created dialog window instead of the system message of the GOT
A created dialog window can be displayed instead of the system message of the GOT.
This is called the system message replacement display.
Storing 0 to the screen switching device closes the displayed dialog window.
Example)
Displaying the window screen with the screen number 20 instead of the system message at an error operation
(Screen switching device (dialog window): D300)

The following table lists the system messages available for the replacement display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Line A 258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 . Enter

Line A 258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 . Enter

D300: 0 D300: 20

The device value of D300 
is changed. (0 to 20)

A dialog window 
(window screen with the screen 
number 20) is displayed.

The input value is beyond 
the range. 
Input a correct value.

OK

Dialog window

System message to be replaced Setting item of the [Environmental 
Setting] window Setting unit

[Communication error. Refer to System Alarm 
in Utility Menu.]

[Communication Circuit Check 
Demand] Project

[Input data error, too many integer places]*1 [Input Digits Overflow (Integer Part)] Project Screen

[Input data error, too many decimal places]*1 [Input Digits Overflow (Decimal Part)] Project Screen

[Interlock not] [Input Condition Failure] Project Screen

[Input data error, number too large/small] [Input Digits Overflow] Project Screen

[Input data error, out of range] [Out of Input Range] Project Screen

[Do you want to change?] [Input Confirmation] Project Screen

[Coordinates error] [Overlap of Objects] Project

[Barcode/RFID data is invalid.] [Invalid Bar Code/RFID Data] Project Screen

Line A 258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 . Enter

Line A 258

7 8 9 Delete
4 5 6 Clear
1 2 3
0 . Enter

D300: 0 D300: 20

The data beyond 
the range is input 

by the numerical input. 
(Error operation)

A dialog window is displayed instead of the 
system message.

The input value is beyond 
the range. 
Input a correct value.

OK

The data beyond the range is input. 
-32767 <= input <= 32767

OK

System message Dialog window

The screen number of the displayed 
window screen is stored.
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*1 Available only when the data type of the monitor device is real number.
For how to set the [Environmental Setting] window, refer to the following.

➟5.2.3 ■4 [Dialog Window...]

(3) Setting procedure
Step 1 Set a screen switching device.

➟5.2.1 ■5 [Screen Switching/Window]
Step 2 Create a dialog window using the dialog window wizard.

For the creation procedure, refer to the following.
➟2.5.1 ■4 Creating a window screen for a dialog window

Step 3 Configure the setting of the dialog window in the [Environmental Setting] window when replacing a system 
message with the window.
For the setting procedure, refer to the following.

➟5.2.3 ■4 [Dialog Window...]

■3 Precautions

(1) Setting for closing the dialog window
Configure the setting for closing the dialog window.
If the dialog window is not closed, monitor screens or utility screens cannot be displayed.
The setting includes: arranging a touch switch for closing the window, script that writes 0 to the screen switching device, 
and a sequence program.

(2) Communication between the GOT and GT Designer3 while a dialog window is displayed
While a dialog window is displayed, communication between the GOT and GT Designer3 may not be established.
If communication between the GOT and GT Designer3 is not established, close the dialog window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Dialog Window...]

In [Dialog Window...], set the display method of the dialog window.
Select [Common] → [GOT Environmental Setting] → [Dialog Window...] from the menu to display this window.

1) [System message to be replaced in Dialog Window]
Select a system message to be replaced by the dialog window.
The selected system message is replaced with the window screen set in [Window Screen No.].
The following shows the items to be selected.

• [Communication Circuit Check Demand]
• [Input Digits Overflow (Integer Part)]
• [Input Digits Overflow (Decimal Part)]
• [Input Condition Failure]
• [Input Digits Overflow]
• [Out of Input Range]
• [Input Confirmation]
• [Overlap of Objects] (Not available to GT21 and GS21)
• [Invalid Bar Code/RFID Data]

For the system messages of each item, refer to the following.
➟5.2.3 ■2 (2) Displaying a created dialog window instead of the system message of the GOT

2) [Window Screen No.]
Set a screen number of the window screen to be displayed instead of the system message.
The setting range is [0] to [32767].
When [0] is set, either system message or dialog window is not displayed.

3) [Screen Switching] button
Displays the setting screen for the screen switching devices.

➟5.2.1 ■5 [Screen Switching/Window]
4) [Dialog Window Switching Device:]

Displays the currently set screen switching device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
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5.2.4 Setting key windows ([Key Window])

➟■1 Specifications of key windows
■2 How to use key windows
■3 Precautions
■4 [Key Window]
■5 Relevant settings

The key window is a window for inputting numerical values and characters which are used for objects including numerical 
input and text input.
The key window has two types: GOT default key window (standard key window) and key window created by the user 
(user-created key window).

■1 Specifications of key windows

➟(1) Specifications of the standard key window
(2) Key window for inputting numeric values (GT27, GT25, GT23,GT SoftGOT2000, and GS25)
(3) Key window for inputting numeric values (GT21 and GS21)
(4) Key window for inputting characters (Alphabet or kana mode) (GT27, GT25, GT23, GT SoftGOT2000, and 

GS25)
(5) Key window for text (key window that supports Kana-Kanji/Pinyin conversion) (GT27, GT25, GT 

SoftGOT2000, and GS25)
(6) Key window for inputting characters (Alphabet or kana mode) (GT21 and GS21)
(7) Specifications of the user-created key window
(8) Common specifications of the standard key window and user-created key window

(1) Specifications of the standard key window
The standard key window is a GOT default window for inputting numerical values and characters.
The standard key window automatically appears according to the input area format (hexadecimal, decimal, octal, binary, 
or text).
The design of the standard key window varies depending on the design selected in the [Screen Design] dialog.
(Not available to GT23, GT21, and GS21)

➟2.4.3 [Screen Design] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Key window for inputting numeric values (GT27, GT25, GT23,GT SoftGOT2000, and GS25)

Example) Key window for inputting numeric values on GT27-S
When the design is set to [Basic-Black]

1) Input value display
Displays the input value.

2) Current value display
Displays the current value of the device.

3) Input range display
Displays the valid input range.
The displayed input range depends on the number of displayed digits which is set for the numerical input.
The following shows the meaning of displayed symbols.

• [INPUT]: Value to be input
• [<]: The left side of the symbol is less than the right side.
• [<=]: The left side of the symbols is less than or equal to the right side.
• [==]: The left side of the symbols is equal to the right side.
• [!=]: The left side of the symbols differs from the right side.

4) Numeric keys
Input a numeric value.

5) [+/-] key
Switches the input value between + and -.

6) [.] key
Inputs a decimal point.

7) [Enter] key (Enter key)
Writes the input value to the device.

Item Description

Hexadecimal input The key window for inputting hexadecimal values is displayed.

Decimal input The key window for inputting decimal values is displayed.

Octal input
While GS450.b7 is on, the key window for inputting octal values is displayed. While GS450.b7 is off, the key window 
for inputting hexadecimal values is displayed.
After the key window is displayed, turning on or off GS450.b7 does not change the key window type.

Binary input
While GS450.b6 is on, the key window for inputting binary values is displayed. While GS450.b6 is off, the key window 
for inputting hexadecimal values is displayed.
After the key window is displayed, turning on or off GS450.b6 does not change the key window type.

Key window for inputting hexadecimal values

2)
1)

3)

4)

5)

10)

11)

6) 7)

9)
8)

Key window for inputting decimal values

2)
1)

3)

4)

5)

10)

11)

6)7)

9)
8)

Key window for inputting octal values

2)
1)

3)

4) 10)

11)

7)

9)
8)

Key window for inputting binary values

2)
1)

3)

4) 10)

11)

7)

9)
8)
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8) [AC] key
Deletes the input value.

9) [Del] key
Deletes the least significant digit in the character string.

10) Keys to move the cursor within a screen
Moves the input cursor in the screen.

11) Keys to move the cursor within an input object
Moves the cursor in the currently input object.
5. COMMON SETTING
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(3) Key window for inputting numeric values (GT21 and GS21)

Example) Key window for inputting numeric values on GT21 and GS21

Item Description

Hexadecimal input The key window for inputting hexadecimal values is displayed.

Decimal input The key window for inputting decimal values is displayed.

Octal input The key window for inputting octal values is displayed.

Binary input The key window for inputting binary values is displayed.

Large key window for inputting 
hexadecimal, octal, and binary values

Small key window for inputting 
hexadecimal, octal, and binary values

GT2107-W, GT2105-Q, GS21

1) 1)

2) 2)
6)

7)

3) 4) 5) 3) 4) 5)

Large key window for 
inputting decimal values

Small key window for 
inputting decimal values

1) 1)

2) 2)
6)

7)

8)

3)
4)
9)

3)

4)
9)

5) 8) 5)

GT2104-R

Key window for inputting 
hexadecimal, octal, and binary values

Key window for 
inputting decimal values

Key window for inputting 
hexadecimal, octal, and binary values

Key window for 
inputting decimal values

1) 1)

1)1)

2) 2)

3) 4) 5) 8) 5)

8) 9)

GT2104-P

3)
4)

9)

3)
10)

4)
5)

3)
10)

4)
5)

2) 2)

Key window for inputting 
hexadecimal, octal, and binary 

values (Numeric mode)

Key window for 
inputting decimal values

1)1)

8) 9)

GT2103-P

3)
10)

4)
5)

3)
10)

4)
5)

2)

Key window for inputting 
hexadecimal, octal, and binary 

values (Alphabetic mode)

1)
3)
10)

4)
5)

2) 2)

11) 11)
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1) Input value display
Displays the input value.

2) Numeric keys
Input a numeric value.
Moves the cursor in the currently input object.

3) [AC] key
Deletes the input value.

4) [Del] key
Deletes the least significant digit in the character string.

5) [Enter] key (Enter key)
Writes the input value to the device.

6) Keys to move the cursor within a screen
Moves the input cursor in the screen.

7) Keys to move the cursor within an input object
Not available to GT21.

8) [.] key
Inputs a decimal point.

9) [+/-] key
Switches the input value between + and -.

10) [ESC] key (GT2104-P and GT2103-P only)
Closes the key window.

11) Display switching keys (GT2103-P only)
Switch between numeric mode and alphabetic mode.
To switch to alphabetic mode, touch the [A-F] key.
.To switch to numeric mode, touch the [0-9] key.

(1) Displaying the vertically-oriented key window for inputting hexadecimal values (GT2104-
P and GT2103-P only)
The vertically-oriented key window cannot display all the alphanumeric characters for input at once.
Touch the [A-F] key or the [0-9] key to display alphabetic characters or numerics for input.

Key window for inputting 
hexadecimal values (Numeric mode)

GT2104-P，GT2103-P

Key window for inputting 
hexadecimal values (Alphabetic mode)
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(4) Key window for inputting characters (Alphabet or kana mode) (GT27, GT25, GT23, GT SoftGOT2000, 
and GS25)
You can switch the input mode sequentially or to any mode directly with applicable keys.
In the input area of an object, characters are displayed in a character code specified in the setting dialog of the object.
Example) Key window for inputting characters on GT27-S
When the design is set to [Basic-Black]

1) Input value display
Displays the input value.

2) Current value display
Displays the current value of the device.

3) Keys for switching character types directly
Switches the character types of the key window directly.
The keys for switching to hiragana or katakana appear only when the system language is Japanese.

4) Character keys
Use the keys to input characters to objects.
The displayed keys depend on the character types of the key window.

5) [AC] key
Deletes the input character string.

6) [DEL] key
Deletes a character to the right of the cursor.

7) Keys for switching character types sequentially
Switches the character types of the key window sequentially.
Since all hiragana characters or katakana characters are too many to be displayed on one key window, the 
characters are separately listed in two windows (first half and latter half).
Use the keys for switching character types sequentially to switch the display between the first half and latter half.

Key window in alphabet mode Key window in kana mode

2)
1)

3)

8)

9)

4)

6)
5)

10)

7)

Displays the keyboard for small letters.

Displays the keyboard for numeric characters.

Displays the keyboard for symbols.

Displays the keyboard for hiragana.

Displays the keyboard for katakana.

Displays the keyboard for capital letters.
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8) Keys to move the cursor within an input object
Moves the cursor in the currently input object.

9) Cursor keys (screen)
Moves the input cursor in the screen.

10) [Enter] key (Enter key)
Writes the input characters to the device.

(5) Key window for text (key window that supports Kana-Kanji/Pinyin conversion) (GT27, GT25, GT 
SoftGOT2000, and GS25)
The key window can be used when all the following conditions are satisfied.

• [Kana-Kanji/Pinyin Conversion] is selected in the [Text Input] dialog.
• The system language and Character Code Control are set.

➟5.2.13 ■1 (1) Conditions that enable KANA-KANJI conversion
5.2.13 ■1 (2) Conditions that enable Kana-Kanji/Pinyin conversion

• Switch to Key Window capable of Kana-Kanji Conversion (GS467.b1) is turned on.
➟5.2.13 Configuring the settings to convert a text into kanji or Simplified Chinese characters in the GOT ([Kana-

Kanji/Pinyin Conversion])
8.5.5 [Text Input] dialog

Kana-Kanji conversion and Pinyin conversion cannot be used simultaneously.
Set a conversion method in the [Kana-Kanji/Pinyin Conversion] window in the [Environmental Setting] dialog.

➟■4 [Kana-Kanji/Pinyin Conversion]
You can switch the character types of the key window using keys for switching character types sequentially or keys for 
switching character types directly.
Example) Key window for inputting characters on GT27-S
When the design is set to [Basic-Black]

1) Input value display
Displays the input value.

2) Keys for switching character types directly
Switches the character types of the key window directly.

3) Character keys
Use the keys to input characters to objects.
The displayed keys depend on the character types of the key window.

Keys for switching character types sequentially

Hiragana (first half) Hiragana (latter half)

1)

2)

7)
8)

3)

5)4)

10)

6)

11)

9)

Key window in alphabet mode Key window in kana mode
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4) [AC] key
Deletes the input character string.

5) [DEL] key
Deletes a character to the right of the cursor.

6) Keys for switching character types sequentially
Switches the character types of the key window sequentially.
Since all hiragana characters or katakana characters are too many to be displayed on one key window, the 
characters are separately listed in two windows (first half and latter half).
Use the keys for switching character types sequentially to switch the display between the first half and latter half.

7) Cursor keys
The behavior differs depending on the status of the character string.
• The character string is not converted.

The keys move the cursor.
• The character string is converted.

The keys change the range of the characters to be converted.
8) Convert key

Converts the input character string.
If you touch this key during the conversion, the converted characters will be restored to their original state.

9) Select key
Confirms the entry.
When you convert multiple groups of hiragana characters, confirm each group of characters with the select key.

10) Previous key or Next key
Converts the input character string by group of characters.
If you touch this key during the conversion, another conversion candidate will be displayed.

11) [Enter] key (Enter key)
Writes the input characters to the device.

(6) Key window for inputting characters (Alphabet or kana mode) (GT21 and GS21)
You can switch the input mode sequentially or to any mode directly with applicable keys.
In the input area of an object, characters are displayed in a character code specified in the setting dialog of the object.
Example) Key window for inputting characters on GT21 and GS21

1) Input value display
Displays the input value.

2) Character type switching keys (One-tap type only)
Switches the character types of the key window directly.

3) Character keys
Use the keys to input characters to objects.

One-tap key window for 
inputting character strings

Multi-tap key window for 
inputting character strings

Multi-tap key window for 
inputting character strings

GT2107-W, GT2105-Q, GS21 GT2107-W, GS21

GT2104-R GT2104-P GT2103-P

1) 1)

3)

3)
4)

2)

5)
6)

8)

7)

7)
6)

10)
9)

8)

GT2105-Q

1)

3)

7)
6)

10)
9)

8)

Multi-tap key window for 
inputting character strings

Multi-tap key window for 
inputting character strings

Multi-tap key window for 
inputting character strings

1)
1)

3)
3)

1)

3)6)
7)

6)
7)
8)

11)
6)
7)
8)

11)

9)
10)

8)

10)9)
10)9)
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The displayed keys depend on the character types of the key window.
4) Keys to move the cursor within a screen (One-tap type only)

Move the input cursor to a different input object on the screen.
5) Keys to move the cursor within an input object (One-tap type only)

Not available to GT21 and GS21.
6) [AC] key

Deletes the input character string.
7) [DEL] key

Deletes a character to the right of the cursor.
8) [Enter] key (Enter key)

Writes the input characters to the device.
9) Keys for switching character types sequentially

Switches the character types of the key window sequentially one by one.
10) Arrow key (Multi-tap type only)

In the multi-tap key window, each character key bears multiple letters.
Repeatedly touching the same character key cycles through the letters on the key.
To enter the letters on a character key in succession, use an arrow key.
Example) when entering "TU"
Touch the [TUV] key once, touch the [→] key once, and then touch the [TUV] key twice.

11) [ESC] key (GT2104-P and GT2103-P only)
Closes the key window.

(7) Specifications of the user-created key window
The user-created key window is a window for inputting numerical values and characters which is created by the user.
Assign the window screen created by the user as a key window.

(a) Available screen size and number of screens
For the specifications of the user-created key window, refer to the following.

➟1.2.3 ■2 Screen specifications

(b) Key window types
The available key window types are the key window for decimal numbers, key window for hexadecimal numbers, and key 
window for character strings (ASCII, S-JIS).

(c) Available figures and objects
You can place all the figures and objects placeable on the window screen.
Some restrictions are placed on the use of the following objects.

(d) Superimposition of objects and layer setting
The superimposition of objects is available on the key window
The layer setting is also available.

(e) Setting of the screen script and trigger action
The screen scripts and trigger actions set for key windows are not executed.

(f) Placing key window objects
For the settings of the key window object, refer to the following.

➟8.31.4 [Input Value Area Setting] dialog
8.31.5 [Input Range Area Setting] dialog

GOT Displayed key window

GT27, GT25, GT23, GS25 Key window for inputting hexadecimal values While GS450.b6 is on, the key window for inputting binary 
values is displayed. While GS450.b7 is on, the key window for inputting octal values is displayed.

GT21, GS21 For binary input on the numerical input: Key window for inputting binary values For octal input on the 
numerical input: Key window for inputting octal values

Object Restriction

Numerical input, text input

The input operation is not available. The following shows applicable fonts.
• 16-dot Standard (Gothic)
• 16-dot Standard (Mincho)
The font size can be specified by selecting an integral multiple (1 or 2) for width and height each.

Key Window Object

One object can be placed on one screen. The following shows applicable fonts.
• 16dot Standard Gothic]
• 16dot Standard Mincho]
The font size can be specified by selecting an integral multiple (1 or 2) for width and height each.
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8.31.6 [Input Maximum Value Area Setting] dialog
8.31.7 [Input Minimum Value Area Setting] dialog
8.31.8 [Previous Value Area Setting] dialog

(8) Common specifications of the standard key window and user-created key window
(a) Display position of the key window

The key window is displayed on the bottom right of the input object by default.
For how to set the window position, refer to the following.

➟8.30.2 How to use the window position

(b) Key window action
You can set the following key window actions for each project or screen.

• Actions of the cursor and key window when the operating condition is satisfied, the operating condition is not satisfied, 
and the screen is switched

• Display method of the cursor input area
• Display method and clear method of the key window

For how to configure the setting for each project, refer to the following.
➟5.2.4 ■4 (2) [Advanced Setting] tab

For how to configure the setting for each screen, refer to the following.
➟2.7.1 ■3 [Key Window Advanced Setting] tab

■2 How to use key windows

(1) How to display key windows
The key window appears when you touch an object such as numerical input and text input, which requires data input.
The input area format determines the key window type.
The key window for inputting binary or octal values is controllable with GS450. (Not available to GT21 and GS21)

➟5.2.4 ■1 (1) Specifications of the standard key window
　 5.2.4 ■1 (7) Specifications of the user-created key window

You can change the type of the key window to be displayed for each project or screen.
Create multiple key windows and set an appropriate key window for each screen.

For the settings of the key window displayed for each project, refer to the following.
➟5.2.4 ■4 (2) [Advanced Setting] tab

For the settings of the key window displayed for each screen, refer to the following.
➟2.7.1 ■3 [Key Window Advanced Setting] tab

(2) How to operate key windows
The following shows the basic operations.

Step 1 Touch an object to which data is to be input.

Step 2 The key window appears. Input a numerical value or character string.
Then, touch the [Enter] button to write the numerical value or character string to the device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Base screen 1 Base screen 2 Base screen 3 Base screen 4

Standard key window User-created 
key window 1

User-created 
key window 2

D100 100

D200 100
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Step 3 The input data is applied to the object and the key window closes.

(3) Displaying a key window off-screen
Not available to GT21 and GS21.
To display a key window off the GOT screen, select [Display windows beyond the screen area] in the [Screen Switching/
Window] dialog.
The key window can be displayed off the right side or the bottom of the screen.

➟5.2.1 ■5 [Screen Switching/Window]

(4) How to move key windows
(a) Moving the window with touch operations

Touch the title bar of a key window, and then touch the position to move the window to within three seconds.

D100 200
D200 100

D100 200
D200 100

When [Display windows beyond the screen area] 
is deselected

When [Display windows beyond the screen area] 
is selected

Moving 
a key window

Touch 
the title bar.

1.

Touch a point to move 
within 3 seconds.

2.
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(b) Moving the window with a slide operation
While touching the title bar of a key window, slide the window to its destination.

(5) How to create a user-created key window
(a) Outline procedure of creation

Step 1 Select [Screen] → [New] → [Window Screen...] from the menu to create a window screen.

➟2.5.1 ■2 Creating a window screen
Step 2 According to the application of the key window, place key code switches to which key codes are set, key 

window objects, and other objects and figures.

You can create a key window easily by using the buttons for numerical input and text input which are 
registered in the library.

Various types of touch switches are registered in the library.
For how to use the library, refer to the following.

➟8.1.2 How to use the library
Step 3 Configure the setting to use the created window screen as a key window.

As appropriate, set also how to display the key window and the action of the cursor.
➟5.2.4 ■4 [Key Window]

Touch 
the title bar.

1.

While touching the title bar, 
slide the window to its destination.

2.
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Step 4 To display the input value and input range, configure the settings such as the display format and display 
position.

➟8.31 Placing an Object to Display the Input Information

Step 5 Check the display image on GT Designer3.

➟2.9.1 Displaying a preview

(b) Buzzer setting
You can set whether to sound the buzzer when moving the window on GT Designer3 or in the GOT utility.
For the setting on GT Designer3, refer to the following.

➟5.3.3 ■2 [Operation Setting/Utility Call Key]
For the setting on the GOT utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)

■3 Precautions

(1) When no cursor is displayed at an input target object
To input a value using key windows, a cursor must be displayed at the input target object.
If no cursor is displayed at the input target object when a key window is displayed, note the following precautions.

• Input values, valid input range, and previous values are not displayed on the displayed key window.
• Even if the operating condition which has been satisfied goes to be unsatisfied while a key window is displayed, the 

key window being displayed is not switched to another key window.
Even if the operating conditions of all the input objects go to be not satisfied, the key window remains displayed.

Select a window screen 
used as a key window.

Configure the setting such as 
the display position and 
the number of displayed digits 
for the input value.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Setting to close the key window whose title bar is hidden
When [Display the title bar on the user-created key window] is deselected in the [Display Detail Setting] dialog, you cannot 
close the key window with the [×] button because the button is hidden.
Configure one of the following settings to close the key window.

• Place a key code switch for which [key Code Type] is set to [Numerical/Text Input] and [Action] is set to [Cancel].
• Select [Clear the key window and the cursor] for [Defined key action] in the [Environmental Setting] window 

([Advanced Setting] tab).

■4 [Key Window]

On this window, set how to display the key window for each project.
Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display this window.

➟5.2.4 ■4 (1) [Basic] tab
　 5.2.4 ■4 (2) [Advanced Setting] tab

For how to display the key window for each screen, refer to the following.
➟2.7.1 Property of base screens

2.7.2 Properties of window screens

(1) [Basic] tab

1) [Key Window]
Select the type of a key window to be used.
The following shows the items to be selected.

• [Standard]
Uses the standard key window pre-installed in the GOT.

• [User-created (individual setting)]
Uses the standard key window or the user-created key window.
Set the key window to be used in [Individual Setting].

2) [Individual Setting]
Set the key window to be used for each input target.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Change display screen in conjunction with 
Language Switching]

Changes the key windows to be used in conjunction with the value of the language 
switching device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

1)

2)

3)

4)
5)

7)
8)

6)

For GT27, GT25, GT23, GT SoftGOT2000, and GS25 For GT21 and GS21
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[Language]

Select the value of the language switching device.
The setting range is [1] to [30].

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
For each value of the language switching device, you can set a key window to be used.
If you select [User-created] in [Key window type], [*] is added to the value of the selected 
range. Example)
• If the value of the language switching device is 1, the standard key window is used for 

text input.
• If the value of the language switching device is 2, the user-created key window is used 

for text input.

[Key Window...] The use of each key window

[Key Window Type]

Select the type of key windows according to their uses.
The following shows the items to be selected.
• [Standard]

Uses the standard key window.
• [User-created]

Uses the created window screen as a key window.
Set the window screen to be used in [Window Screen No.].

Item Description

Select [2] for [Language] and select [User-created] for 

[Key Window Type] in [Text ].

Select [1] for [Language] and select [Standard] for 

[Key Window Type] in [Text ].
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3) [Display standard key window for Text]
Not available to GT21 and GS21.
Uses the standard key window for text input.

4) [Display value during input]
Not available to GT21 and GS21.
Displays the value being input in the key window.
To display the value in the user-created key window, arrange the input value area setting on the window screen.

➟8.31 Placing an Object to Display the Input Information
5) [Display previous value]

Not available to GT21 and GS21.
Displays the previous value in the key window.
To display the previous value in the user-created key window, arrange the previous value area setting on the 
window screen.

➟8.31 Placing an Object to Display the Input Information
6) [Display input function range]

Not available to GT21 and GS21.
Displays the valid input range in the key window.
To display the valid input range in the user-created key window, arrange the input range area setting on the window 
screen.

➟8.31 Placing an Object to Display the Input Information

[Window Screen No.]

If you select [User-created] in [Key Window Type], set the window screen number to be 
displayed as a key window.
The setting range is [1] to [32767].
Click the [...] button to display the [Screen Image List] dialog.
You can check the image on the screen when selecting a window screen.

• [Screen Name]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the screen in the screen 
image list.

[Number of used screens]

This can be set only to [Text].
Set the number of key windows used for text input.
With the window screen set in [Window Screen No.] as the first on the list, window screens 
are used for the set number as key windows.
To switch key windows, arrange key code switches to which the following operations are 
set.
• [Switch window screens for ASCII (to the next)]
• [Switch window screens for ASCII (to the previous)]
• [Switch window screens for ASCII (screen no. specification)]

➟8.2.11 [Key Code Switch] dialog

Item Description

Screen image list

Jump
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7) [Standard Key Window Size for Dec/Hex]
Not available to GT2104-R, GT2104-P, and GT2103-P.
Select the size of the key window.
The following shows the setting range.

• [Large]
• [Small]

8) [Standard Key Window Type for Text]
Not available to GT2104-R, GT2104-P, and GT2103-P.
Select the type of the key window.
The following shows the setting range.

• [Toggle]
• [One-touch]

(2) [Advanced Setting] tab

1) [When operating conditions are satisfied]
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are satisfied.

2) [When screens are switched]
Configure the display settings of the key window and cursor to switch screens for when the operating conditions of 
the object for input are satisfied.

Item Description

[Key Window]

Configure the display settings of the key window for when the operating conditions of the objects for 
input are satisfied. The following shows the items to be selected.
• [Display at any time] (Not available to GT21 and GS21)
• [Display when touched]
• [Hide]

[Cursor]
(Not available to GT21 and GS21)

Configure the display settings of the cursor for when the operating conditions of the object for input 
are satisfied. The following shows the items to be selected.
• [Display at any time]
• [Display when touched]

Item Description

[Display the key window] Displays a key window when the screen is switched.

[Display the cursor] Displays a cursor when the screen is switched. Set the position to display the cursor in [Cursor 
Position].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

5)
6)

7)
8)

9)
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3) [When operating conditions are not satisfied]
Not available to GT21 and GS21.
Configure the display settings of the key window and cursor for when the operating conditions of the objects for 
input are not satisfied.

4) [Detail setting for key window/cursor]
Click the [Setting] button to display the [Display Detail Setting] dialog.

5) [Defined key action]
Select the action of the key window and cursor when the enter key is touched.
The following shows the items to be selected.

• [Clear the key window and the cursor]
Deletes the key window and cursor.

• [Control the cursor]
Moves the cursor to the specified position.
Select a position to move the cursor in [Cursor Move Destination].

6) [Cursor Move Destination]
Select a position to move the cursor.

[Cursor Position]

Select the position to display the cursor when the screen is switched. The following shows the items 
to be selected.
• [Upper left]

Displays the cursor at the object nearest to the upper left corner of the screen.
• [User ID minimum]

Displays the cursor at the object with the smallest user ID.
• [User ID specification]

Displays the cursor at the object with the specified user ID.
Set the user ID of the object on which the cursor is displayed in [User ID].

[User ID] Sets the user ID of the object on which the cursor is displayed. The setting range is [1] to [65535].

Item Description

[Clear the key window and the cursor] Deletes the key window and cursor when the operating conditions of the objects for input 
are not satisfied.

[Clear the input object] Deletes the key window, the cursor, and the objects for input when the operating conditions 
of the objects for input are not satisfied.

• [Cursor Type]
Select the action of the cursor to be displayed at the input area.
• [1-character blink]

Blinks the area for one character in the input area.
• [Highlight all + 1-character blink]

Highlights the characters displayed in the input area, and blinks 
the area for one character.

• [Display the cursor with a touch on the Enter/arrow key when 
the cursor is hidden]
Not available to GT21 and GS21.
Displays the cursor when the enter key or an arrow key is touched 
while the cursor is hidden.

• [Display the valid input range when an invalid value is input in 
Numerical Input]
Not available to GT21 and GS21.
Displays the dialog indicating the valid input range when an invalid 
value is input in numerical input.

• [Display the input confirmation dialog when setting the function 
of Numerical/ASCII Input]
Displays the confirmation dialog when numerical values or text are 
input.

• [Check the input range while entering numerical values]
Not available to GT21 and GS21.
This item is enabled only when an input range is set.
The error message is displayed when a value out of the setting 
range is being entered.
➟8.4.5 ■3 [Input case] tab

• [Display the title bar on the user-created key window]
Not available to GT2104-P and GT2103-P.
Displays the title bar of a user-created key window.
For the precautions on hiding the title bar, refer to the following.
➟5.2.4 ■3 (2) Setting to close the key window whose title bar is 
hidden

Item Description
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The following shows the items to be selected.

Item Description

[Same operation as the right arrow key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

[Same operation as the down arrow key]

Moves the cursor using the specified coordinate point of the active object as a reference.
Specify the reference coordinate point with [Reference for determining cursor destination].
The cursor moves as shown below.

[In order of user ID]

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.If the destination object is hidden due to unsatisfied conditions, the 
cursor does not move.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[Subsequently valid user ID]
(Not available to GT21 and GS21)

Moves the cursor to the object that has the same user ID number as the move destination ID 
number of the active object.If the destination object is hidden due to unsatisfied conditions, the 
cursor moves to the object specified with [Move Destination ID] of the hidden destination object.
To control the cursor movement, set [User ID] and [Move Destination ID] of the relevant objects.

[Not move] Does not move the cursor even after the entry is confirmed.

Object A

Object B Object C

Object D

1

2

3 1

2

3

Object A
Object B

Object C
Object D

1 2 3

12 3

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object D
・[User ID]: 4
・[Move Destination ID]: 5

Object C
・[User ID]: 3
・[Move Destination ID]: 4

The cursor does not move to this object 
because the object is hidden due to unsatisfied conditions.

The cursor moves to this object.

Object A
・[User ID]: 1
・[Move Destination ID]: 2

Object B
・[User ID]: 2
・[Move Destination ID]: 3

Object C
・[User ID]: 3
・[Move Destination ID]: 4

Object D
・[User ID]: 4
・[Move Destination ID]: 5

The cursor does not move 
to this object because the object 
is hidden due to unsatisfied conditions.
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7) [When the cursor cannot shift]
This item is displayed when [Cursor Move Destination] is set to [In order of user ID] or [Subsequently valid user ID].
Select how the cursor moves when no destination object exists.
The following shows the items to be selected.

• [Not move]

• [Clear]
8) [Reference for determining cursor destination]

Select the standard to determine a position to move the cursor.
The following shows the items to be selected..

• [Upper left]
• [Lower right]

9) [Key Window Position Correction]
Select an action of the key window when it overlaps the input target object.
The following shows the items to be selected.

• [Not move]
Keeps the key window displayed even if it overlaps the input target object.

• [To the four corners of the screen]
Displays the key window at one of the four corners so that it does not overlap the input target object.
Displays the key window on the lower right of the screen if it overlaps the input target object wherever it is.

• [Around the object]
Displays the key window according to the position of the input target object.
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■5 Relevant settings

Set the relevant settings other than the specific settings for the key window as required.
The following shows the functions that are available by the relevant settings.

(1) GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information...] from the menu to display the [Environmental 
Setting] window.

➟5.2.5 ■1 Specifications of the system information
　 5.2.5 ■4 [System Information]

(2) Internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Disabling touch operations and inputs from external devices
(Read device: System signal 1-1.b9)

[System Signal 1-1]

Notifying whether a key code is entered from an input object (touch switch, numerical 
input, or text input).
(Write device: System signal 2-1.b3)

[System Signal 2-1]

Notifying that the input is determined.
(Write device: System signal 2-1.b4)

[System Signal 2-1]

Notifying that a key window is displayed.
(Write device: System signal 2-1.b11)

[System Signal 2-1]

Notifying the user ID of the numerical input to which an input is determined.
(Write device)

[Numeric Value Input Number]

Notifying the key code which is set for the touched key.
(Write device)

Not available to GT21 and GS21.
[Key Code Input]

Notifying the value before the change (32 bits). (Write device) [Previous Numeric Value Input(32bit)]

Notifying the fixed input value (32 bits). (Write device) [Current Numeric Value Input(32bit)]

Function Setting item

Displaying the dialog for confirming the input contents when an input is fixed for 
numerical input and text input.

Not available to GT21 and GS21.
GS450.b0

Displaying the dialog for notifying that an input value is outside the range when the value 
is input for numerical input.

Not available to GT21 and GS21.
GS450.b1

Forcibly closing a key window when the input condition (the trigger condition or security 
level for the object) is not satisfied during a value or text input

Not available to GT21 and GS21.
GS450.b5

Displaying the key window for inputting binary values when the format of the numerical 
input is binary

Not available to GT21 and GS21.
GS450.b6

Displaying the key window for inputting octal values when the format of the numerical 
input is octal

Not available to GT21 and GS21.
GS450.b7

Switching a key window for text input to a key window that supports Kana-Kanji 
conversion or Pinyin conversion

Not available to GT23, GT21, and GS21.
GS467.b1
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5.2.5 Setting a device which controls the GOT operations or notifies the GOT status 
([System Information])

➟■1 Specifications of the system information
■2 How to use the system information
■3 Precautions
■4 [System Information]
■5 [Selection/Sort Setting] dialog
■6 Relevant settings

By setting devices that store the system information, you can control the GOT operations (closing a screen, disabling key 
input) from a controller and notify the GOT status to a controller.
The two types of devices that store system information are shown below.

• Read device
This device controls the GOT operations by writing values from a controller to the read device for controlling the GOT 
operations.
The read device is monitored at the monitoring cycle of the GOT.
The read device value needs to be held for the interval of GOT monitoring cycle or longer.
Example) Turning the GOT to screen saver mode forcibly by a controller

• Write device
By writing a value to the write device for notifying the GOT status, the GOT notifies the GOT status itself to a 
controller.
The write device is updated when the GOT operation status has changed.
Example) Notifying the base screen number currently displayed on the GOT to a controller

■1 Specifications of the system information

The system information is stored in devices assigned to each system information.
• Read device

➟(1) System signal 1-1
(2) System signal 1-2
(3) External I/O output function/output function

• Write device
➟(4) System signal 2-1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Read 
device D10 b0b1b2

Forced screen saver enable signal 
(Closes the screen)

Turn on Forced Screen Saver
Enable signal.

D10.b1=OFF D10.b1=ON

Check the change of the read device 
and close the display.

……

Base screen 1

125

Base screen 5
The GOT operation 
status is written into 
the write device.

Write device: D20
(Stores the base screen number currently displayed)

D20 51

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(5) System signal 2-2
(6) System signal 2-3
(7) Numeric value input number
(8) Previous numeric value input (32 bits)
(9) Current numeric value input (32 bits)
(10) GOT error code
(11) GOT error code 2
(12) Printing report screen number
(13) Extended drive information
(14) Drive Empty Capacity Information
(15) On-screen base screen number
(16) On-screen window 1 to 5 screen number
(17) Current cursor display object ID
(18) Previous cursor display object ID
(19) Current cursor display user ID
(20) Previous cursor display user ID
(21) Key code input
(22) External I/O function/input information 1
(23) External I/O function/input information 2
(24) Previous numeric value input (64 bits)
(25) Current numeric value input (64 bits)

(1) System signal 1-1
This signal controls the GOT from a controller.
The following shows the control details of each bit.

Bit number Signal name Description Supported 
models

b0 Automatic Screen Saver Disable 
signal Turning on this signal disables the screen saver function.

b1 Forced Screen Saver Enable signal
Turning on this signal forcibly turns the GOT into the screen saver mode.
Turning off this signal displays the screen again.

b2 Forced Screen Saver Touch-Cancel 
signal

Turning on this signal cancels the screen saver when the screen is touched 
even during forced screen saving.
The operation condition of the Forced Screen Saver Enable signal (System 
signal 1-1.b1) varies according to on or off of this signal.
• ON: Operates at the rising.
• OFF: Operates during on.

b3 Key Code Read Complete signal

Turning on this signal notifies that the reading of input key code has 
completed to the GOT.
Turning on this signal turns off the Key Input signal (System signal 2-1.b3).

➟(4) System signal 2-1

b4 Numeric Value Input Read Complete 
signal

Turning on this signal notifies the GOT that reading the input value of a 
numerical input object has completed.
Turning on this signal turns off the Numeric Value Input signal (System signal 
2-1.b4), and 0 is stored in the numerical value input number.
For details, refer to the following.

➟(3) Confirm the numerical input determination timing
To use this signal for a text input object, configure one of the following 
settings.
• Selecting [Output object ID of Text Input to the system information device] 

for the [Environmental Setting] window ([System Information])
• Turning on GS450.b2

➟(4) System signal 2-1

　 5.2.5 ■4 [System Information]
12.1.3 GOT special register (GS)

Turning on this signal notifies that the reading of input values for the 
numerical input and text input has completed to the GOT.
Turning on this signal turns off the Numeric Value Input signal (System signal 
2-1.b4), and 0 is stored in the numerical value input number.
For details, refer to the following.

➟(3) Confirm the numerical input determination timing

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(a) Screen control at the screen saver mode
The following shows the priority for the screen control at the screen saver mode.

b5 Barcode Input Disable signal (CH8) Turning on this signal disables the barcode function for the channel No. 8.

b6 External Device I/ O Complete signal 
(CH8)

Turning on this signal notifies the GOT that reading data from the device, 
which the barcode or the RFID input data is stored in, is completed.
Turning on this signal turns off the External Device I/O signal (CH8) (System 
signal 2-1.b6).

➟(4) System signal 2-1

b7 - Use prohibited

b8 Buzzer Three-shot Output signal

Turning on this signal sounds the buzzer three times.
Set the buzzer length in the utility.
The buzzer is sounded even when [Buzzer] is set to [None] in the [GOT 
Setup] window ([Operation Setting/Utility Call Key]).

➟5.3.1 ■2 [Display Setting/Language Setting]

b9 Disable Touch Operation signal Turning on this signal disables touch operations and inputs from external 
devices.

b10 Hard Copy Setting Validate signal

Turning on this signal enables the reverse printing of the hard copy function 
with system signal 1-1.b12.
When this signal is turned off, the reverse printing is settable in the [Hard 
Copy] dialog.

➟9.7.6 ■2 [Printer] tab

b11 - Use prohibited

b12 Hard Copy White/Black Reverse 
signal

Turning on this signal reverses black and white of the monitor screen.
Reversing black and white is enabled only when the output destination is a 
printer.

b13 GOT Error Reset signal

Turning on this signal processes the followings.
• Storing 0 to the GOT error code (Write device)
• Turning off the GOT Error Detection signal (System signal 2-1.b13)
• Clearing system alarm messages

➟(4) System signal 2-1
(10) GOT error code

b14 Buzzer Output signal
While turning on this signal, the buzzer is sounded.
The buzzer is sounded even when [Buzzer] is set to [None] in the [GOT 
Setup] window ([Operation Setting/Utility Call Key]).

b15 Buzzer One-shot Output signal

Turning on this signal sounds the buzzer once.
Set the buzzer length in the utility.
The buzzer is sounded even when [Buzzer] is set to [None] in the [GOT 
Setup] window ([Operation Setting/Utility Call Key]).

Priority System information and function
System 

information 
condition

Screen saving status

Forced Screen Saver Touch-Cancel signal (System signal 1-1.b2) ON Screen saver disabled

Forced Screen Saver Enable signal (System signal 1-1.b1) ON Screen saver enabled

Automatic Screen Saver Disable signal (System signal 1-1.b0) ON Screen saver disabled

Screen saver function by the utility setting - Screen saver enabled

Displaying user-created screens or the utility screen - Screen saver disabled

Bit number Signal name Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

High

Low
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(b) Relationship between the screen saver function and the Disable Touch Operation signal
The following shows the relationship between the screen saver function and the Disable Touch Operation signal.

(2) System signal 1-2
This signal controls the GOT from a controller.
The following shows the control details of each bit.

Forced Screen Saver 
Touch-Cancel signal 

(System signal 1-1.b2)

Forced Screen Saver 
Enable signal (System 

signal 1-1.b1)

Disable Touch 
Operation signal 

(System signal 1-1.b9)

Screen saver function 
by the utility setting Screen status

ON

ON

ON

ON, OFF

The GOT enters the screen saver mode.
Touching the screen cancels the screen saver mode.
The screen does not respond to a touch operation 
even after the screen saver mode has been 
canceled.

OFF

The GOT enters the screen saver mode.
Touching the screen cancels the screen saver mode.
The screen responds to a touch operation after the 
screen saver mode has been canceled.

OFF

ON, OFF
The GOT enters the screen saver mode.
Touching the screen does not cancel the screen 
saver mode.

OFF

ON
The GOT does not enter the screen saver mode.
The screen does not respond to a touch operation.

OFF

ON

The GOT enters the screen saver mode.
Touching the screen cancels the screen saver mode.
The screen responds to a touch operation after the 
screen saver mode has been canceled.

OFF
The GOT does not enter the screen saver mode.
The screen responds to a touch operation.

Bit number Signal name Description Supported 
models

b0 File Access Error Reset signal

Turning on this signal resets all the File Access Error signals (System signal 
2-2.b7 to b9 and extended drive information.b2, b5, and b8) in the drive A, 
B, D, E, F, and G. While this signal is on, the File Access Error Reset signal 
does not turn on.

➟(5) System signal 2-2
(13) Extended drive information

b1 RFID Request signal (CH8) By turning on this signal, the GOT requests to read the data with the channel 
No. 8.

b2 Barcode Input Disable signal (CH5) Turning on this signal disables the barcode function for channel No. 5.

b3 External Device I/O Complete signal 
(CH5)

Turning on this signal turns off the External Device I/O signal (CH5) (System 
signal 2-3.b0).

➟(6) System signal 2-3

b4 RFID Request signal (CH5) By turning on this signal, the GOT requests to read the data with the channel 
No. 5.

b5 Barcode Input Disable signal (CH6) Turning on this signal disables the barcode function for the channel No. 6.

b6 External Device I/O Complete signal 
(CH6)

Turning on this signal turns off the External Device I/O signal (CH6) (System 
signal 2-3.b1).

➟(6) System signal 2-3

b7 RFID Request signal (CH6) By turning on this signal, the GOT requests to read the data with the channel 
No. 6.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(3) External I/O output function/output function
Functions for each signal differ depending on the GOT used.

(a) GT27, GT25-S, and GT25-V
GT2505-V is excluded.
Use the external I/O output function for the external output.
The following shows the control details of each bit.

(b) GT25HS-V

b8 Barcode Input Disable signal (CH7) Turning on this signal disables the barcode function for the channel No. 7.

b9 External Device I/O Complete signal 
(CH7)

Turning on this signal turns off the External Device I/O signal (CH7) (System 
signal 2-3.b2).

➟(6) System signal 2-3

b10 RFID Request signal (CH7) By turning on this signal, the GOT requests to read the data with the channel 
No. 7.

b11 Enable Serial RFID Control During 
External Authentication signal

When this bit is turned on, the operator authentication data read by an RFID 
controller (serial connection) can be saved into devices.

b12 to b14 - Use prohibited

b15 Print Abort signal

Turning on this signal aborts printing when this signal rises. In response to 
the abort of printing, the GOT turns off the Print Output signal (System signal 
2-2.b15).
The user must turn off this signal after confirming that the Print Output signal 
(System signal 2-2.b15) is turned off.

➟(5) System signal 2-2

Bit number Signal name Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Print Abort signal
(System Signal 1-2.b15)

Print Output signal 
(System Signal 2-2.b15)

OFF
ON

OFF
ON

Executed by GOT
Executed by the user

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Bit number Signal name Description

b0 to b15 Output signal Y0 to YF
Write the information for outputting to the external device, such as a lamp or 
relay. These signals are enabled only when an external I/O unit (extension 
unit) is used.

Bit number Signal name Description

b0 to b5 Control Operation Switch LED 
signal

Not available to GT2505HS-V.
Turning on each bit turns on the operation switch LED corresponding to the 
bit.
The following shows the correspondences between the bits and the 
operation switch LEDs.
• b0: SW1 LED
• b1: SW2 LED
• b2: SW3 LED
• b3: SW4 LED
• b4: SW5 LED
• b5: SW6 LED

b6 Control Grip Switch LED signal Turning on this signal turns on the grip switch LED.
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(c) GT21-P
Use the external I/O output function for the external output.
The following shows the control details of each bit.

Bit number Signal name Description

b0 to b6 - Use prohibited

b7 Control Backlight (5 Colors) 
signal

Turning on this signal enables the Specify Backlight Color (5 Colors) signal 
and the Control Backlight Blink signal.

b8 to b10 Specify Backlight Color (5 
Colors) signal

Controls the backlight color (5 colors).

b11 - Use prohibited

b12 Control Backlight (3 Colors) 
signal

Turning on this signal enables the Specify Backlight Color (3 Colors) signal 
and the Control Backlight Blink signal. Turning on the Control Backlight (5 
Colors) signal and the Control Backlight (3 Colors) signal enables the 
Specify Backlight Color (5 Colors) signal.

b13 Control Backlight Blink signal Turning on this signal blinks the backlight.

b14 to b15 Specify Backlight Color (3 
Colors) signal

Specify Backlight Color (3 Colors) signal. The backlight color depends on 
whether [White/Red/Pink] or [Green/Red/Orange] is selected for [Backlight 
color selection for 3-color control] of [System Information] in the 
[Environmental Setting] window.

➟5.2.5 ■4 [System Information]

b8 b9 b10 Backlight color

OFF OFF OFF -(Not lit)

ON OFF OFF White

OFF ON OFF Green

ON ON OFF Use prohibited

OFF OFF ON Red

ON OFF ON Pink

OFF ON ON Orange

ON ON ON Use prohibited

b14 b15
[White/Red/Pink]

OFF OFF -(Not lit)

ON OFF White

OFF ON Red

ON ON Pink

Backlight color

[Green/Red/Orange]

-(Not lit)

Green

Red

Orange
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(4) System signal 2-1
This signal notifies various notifications from the GOT to a controller or the user.
The following shows the notification details of each bit.

Bit number Signal name Description Supported 
models

b0 Screen Saving signal Turns on while the GOT is in screen saver mode.

b1 GOT Ready signal

Shows the GOT status when the GOT is powered on.
• ON: Normal
• OFF: Abnormal
If this signal does not turn on by resetting the GOT, the hardware error may 
occur in the GOT.
Consult your local Mitsubishi service center or representative.

b2 - Use prohibited

b3 Key Input signal

Shows whether a key code is entered from an input object (touch switch, 
numerical input, or text input).
• ON: The key is input.
• OFF: The key is not input.
This signal turns off when the Key Code Read Complete signal (System 
signal 1-1.b3) turns on.

➟(1) System signal 1-1

b4 Numeric Value Input signal

Turns on when a value is input in the numerical input, and the value is 
completed.
Turning on the Numeric Value Input Read Complete signal (System signal 1-
1.b4) turns off this signal.

➟(1) System signal 1-1
To use this signal for the text input, configure any of the following settings.
• Selecting [Output object ID of Text Input to the system information device] 

for the [Environmental Setting] window ([System Information])
• Turning on GS450.b2
This signal does not function when a value is input to the numerical input for 
which a user ID is not set.

Turns on when the data input to a numerical input object or a text input object 
is confirmed.
Turning on the Numeric Value Input Read Complete signal (System signal 1-
1.b4) turns off this signal.

➟(1) System signal 1-1
This signal functions even when data is input to the numerical input object or 
the text input object without a user ID number.

b5 Human Sensor Detection signal

Turns on when the human sensor detects human motion.
This signal turns on for approx. 60 seconds after GOT startup due to the 
sensor's characteristic.
Available to GT27-X and GT27-S.

b6 External Device I/O signal (CH8)

Available when the channel No. 8 is used for the barcode function.
Turns on when the data read by the barcode reader is stored in the specified 
device.

Available when the channel No. 8 is used for the RFID function.
Turns on when the data read by the RFID reader/writer is stored in the 
specified device when the dedicated protocol is used.
Turns on when the data transfer to the RFID controller is completed when 
the nonprocedural protocol is used.
Turns off when the External Device I/O Complete signal (CH8) (System 
signal 1-1.b6) turns on.

b7 Hard Copy Output signal Turns on during an output by the hard copy function.

b8 Report Output signal Turns on during printing by the report function.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(5) System signal 2-2
This signal notifies various notifications from the GOT to a controller or the user.
The following shows the notification details of each bit.

b9 - Use prohibited

b10 Recipe Processing Signal Turns on during recipe process (Write/Read operation).

b11 Key Window Output signal Turns on during displaying the key window.

b12 Hardcopy Sub-signal

Enabled when [Delete the file with the smallest number and create another 
file when the capacity of the destination is exceeded] is selected in the [Hard 
Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Turns on when the number of screen data files (file number) stored in a 
memory card by using the hard copy function is 9900 to 9999.

b13 GOT Error Detection signal

Turns on when an error occurs in the GOT.
When this signal is turned on, check the GOT error code and eliminate the 
cause.
After eliminating the cause, turn on the GOT Error Reset signal (System 
signal 1-1.b13).

➟(1) System signal 1-1
(10) GOT error code
(11) GOT error code 2

b14 Numeric Value Error Detection signal

Turns on when the value exceeding the input range is stored in the write 
target device of the numerical input. (This signal is checked when screens 
are switched.)
When no input range formula is preset to the numerical input, detection is not 
performed.

b15 Printer error detection signal Turns on when a printer error occurs during printing, such as printer power-
off, cable disconnection, no paper, or paper jam.

Bit number Signal name Description Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Bit number Signal name Description Supported 
models

b0 Drive A File Accessing signal Turns on while a file in the drive A is open or while a folder or file is operated.

b1 Drive B File Accessing signal
Not available to GT2505-V and GT25HS-V.
Turns on while a file in drive B is open or a folder or file in drive B is 
manipulated.

b2 Drive C File Accessing signal Turns on while a file in drive C is open or a folder or file in drive C is 
manipulated.

b3 - Use prohibited

b4 Drive A Full signal Turns on when the available space of the drive A is less than 1k byte.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
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GT27 GT25 GT23
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GT21 GS21GS25
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b5 Drive B Full signal
Not available to GT2505-V and GT25HS-V.
Turns on when the available space of the drive B is less than 1k byte.

b6 - Use prohibited

b7 Drive A File Access Error signal Turns on while an access error with a file in the drive A occurs.

b8 Drive B File Access Error signal
Not available to GT2505-V and GT25HS-V.
Turns on while an access error with a file in the drive B occurs.

b9 to b10 - Use prohibited

b11 Cursor Displaying signal Turns on during displaying the numerical input or text input cursor.

b12 Built-in Battery Voltage Drop signal

Not available to GT2103-P and GS21.
Turns on when a voltage drop of the GOT built-in battery is detected. 
If a power failure occurs after this bit turns on, the battery backup data is held 
within the data retention period. 
Replace the battery immediately.

b13 - Use prohibited

b14 Liquid Crystal Backlight Brightness 
Decrease/Failure Detection signal

Not available to GT2104-R, GT2104-P, and GT2103-P.
Turns on when a decrease in brightness or a failure of the liquid crystal 
backlight is detected.

b15 Print Output signal

Turns on when the printing (printing for the hard copy function or the report 
function) starts.
Turns off at the following timing.
• When any device that notifies printing in progress is turned off while a serial 

printer or an Ethernet printer (PCL5) is in use
• When the GOT receives a notification that printing is complete while a 

PictBridge-compatible printer or an Ethernet printer (ESC/P-R) is in use
• When the Print Abort signal (System signal 1-2.b15) is turned on
• When the abort trigger of the report function is turned on
• When the abort trigger of the hard copy function is turned on
• When communication with an Ethernet printer (ESC/P-R) is disconnected

Bit number Signal name Description Supported 
models

GT27 GT25 GT23
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(6) System signal 2-3
This signal notifies various notifications from the GOT to a controller or the user.
The following shows the notification details of each bit.

(7) Numeric value input number
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
This signal stores the user ID number of a numerical input object when a value input to the object is confirmed.
To clear the stored user ID, turn on the Numeric Value Input Read Complete signal (System signal 1-1.b4).
For details, refer to the following.

➟5.2.5 ■2 (3) Confirm the numerical input determination timing
To use this signal for a text input object, configure one of the following settings.

• Selecting [Output object ID of Text Input to the system information device] for the [Environmental Setting] window 
([System Information])

➟5.2.5 ■4 [System Information]
• Turning on GS450.b2

➟12.1.3 GOT special register (GS)
For GT21 and GS21
This signal stores the user ID number of a numerical input object or a text input object when the data input to the object 
is confirmed.
To clear the stored user ID, turn on the Numeric Value Input Read Complete signal (System signal 1-1.b4).
For details, refer to the following.

➟5.2.5 ■2 (3) Confirm the numerical input determination timing

(8) Previous numeric value input (32 bits)
When a value is input in the numerical input, the value before the change (32 bits) is stored.
When the data type of the numerical input is 64 bits, the value of the lower 32 bits is stored.
Only the numerical input to which the user ID is set is effective.

(9) Current numeric value input (32 bits)
The input value (32 bits) determined in the numerical input.
When the data type of the numerical input is 64 bits, the value of the lower 32 bits is stored.
Only the numerical input to which the user ID is set is effective.

Bit number Signal name Description Supported 
models

b0 External Device I/O signal (CH5)

Available when the channel No. 5 is used for the barcode function. Turns on 
when the data read by the barcode reader is stored in the specified device.

Available when the channel No. 5 is used for the RFID function. Turns on 
when the data read by the RFID reader/writer is stored in the specified 
device when the dedicated protocol is used. Turns on when the data transfer 
to the RFID controller is completed when the nonprocedural protocol is used. 
Turns off when the External Device I/O Complete signal (CH6) (System 
signal 1-2.b3) turns on.
➟(2) System signal 1-2

b1 External Device I/O signal (CH6)

Available when the channel No. 6 is used for the barcode function. Turns on 
when the data read by the barcode reader is stored in the specified device.

Available when the channel No. 6 is used for the RFID function. Turns on 
when the data read by the RFID reader/writer is stored in the specified 
device when the dedicated protocol is used. Turns on when the data transfer 
to the RFID controller is completed when the nonprocedural protocol is used. 
Turns off when the External Device I/O Complete signal (CH6) (System 
signal 1-2.b6) turns on.
➟(2) System signal 1-2

b2 External Device I/O signal (CH7)

Available when the channel No. 7 is used for the barcode function. Turns on 
when the data read by the barcode reader is stored in the specified device.

Available when the channel No. 7 is used for the RFID function. Turns on 
when the data read by the RFID reader/writer is stored in the specified 
device when the dedicated protocol is used. Turns on when the data transfer 
to the RFID controller is completed when the nonprocedural protocol is used. 
Turns off when the External Device I/O Complete signal (CH7) (System 
signal 1-2.b9) turns on.
➟(2) System signal 1-2

b3 to b15 b0 Use prohibited

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(10)GOT error code
Not available to GT21 and GS21.
The error code of errors occurred in the GOT is stored.
For details of errors, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(11)GOT error code 2
Not available to GT21 and GS21.
The classification code of errors occurred in the GOT is stored.
The upper 8 bits store ASCII code G (identification code indicating a GOT error).
The lower 8 bits store values indicating a classification code.
Example) For the GOT error (G01) related to the communication and controllers, 4701h is stored.
For details of errors, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(12)Printing report screen number
The screen number being printed is stored.

(13)Extended drive information
This signal notifies the usage status of the extended drive information.
The following shows the notification details of each bit.

(14)Drive Empty Capacity Information
The free space information of each drive is stored.
For GT2107-W, drives A and E are available.
For GT2105-Q, GT2104-R, GT2104-P, GT2103-P, and GS21, only drive A is available.
The value is stored in two word devices.
The unit of the stored value can be specified by using the Unit of Drive Free Space device (GS466).

➟12.1.3 GOT special register (GS)
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

Bit number Signal name Description Supported 
models

b0 Drive E File Accessing signal Turns on while a folder or a file in drive E is manipulated.

(Only available 
to GT2107-W 
of GT21 
models)

b1 Drive E Full signal Turns on when the free space of drive E is less than 1 kilobyte.

b2 Drive E File Access Error signal Turns on while an access error with a file in the drive E occurs.

b3 Drive F File Accessing signal Turns on while a folder or a file in drive F is manipulated.

b4 Drive F Full signal Turns on when the free space of drive F is less than 1 kilobyte.

b5 Drive F File Access Error signal Turns on while an access error with a file in the drive F occurs.

b6 Drive G File Accessing signal Turns on while a folder or a file in drive G is manipulated.

b7 Drive G Full signal Turns on when the free space of drive G is less than 1 kilobyte.

b8 Drive G File Access Error signal Turns on while an access error with a file in the drive G occurs.

b9 Drive N File Accessing signal Turns on while a folder or a file in drive N is manipulated.

b10 Drive N Full signal Turns on when the free space of drive N is less than 1 kilobyte.

b11 Drive N File Access Error signal Turns on when an error occurs while a file in drive N is being accessed.

b12 to b15 - Use prohibited

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(15)On-screen base screen number
The base screen number being displayed is stored.
The following shows the screen number to be stored.

*1 When you select [Retain the screen number of on-screen] in the [Environmental Setting] window, the screen number of the 
screen displayed before the screen switching is stored.

➟■4 [System Information]
*2 If the base screen number is also 9999, the GOT cannot distinguish base screen No. 9999 from the device value (9999) 

during screen switching.

(16)On-screen window 1 to 5 screen number
The screen number of the window screen being displayed is stored.
For GT23, GT21, and GS21, only the screen number of window screen 1 or 2 is stored.
The following shows the screen number to be stored.

(17)Current cursor display object ID
The object ID of the object on which the numerical input or text input is currently displayed is stored.
By setting any of the followings, 0 is stored.

• No object that requires the cursor is displayed on the displayed screen.
• A cursor is not displayed when the screen is switched.

To store 0 when the cursor is deleted, set any of the followings.
• Selecting [Clear the cursor information when deleting the cursor] in the [Environmental Setting] window ([System 

Information])
➟5.2.5 ■4 [System Information]

• Turning on GS450.b3
➟12.1.3 GOT special register (GS)

(18)Previous cursor display object ID
The object ID of the object on which the numerical input or text input is previously displayed is stored.
By setting any of the followings, 0 is stored.

• No object that requires the cursor is displayed on the displayed screen.
• A cursor is not displayed when the screen is switched.

To store 0 when the cursor is deleted, set any of the followings.
• Selecting [Clear the cursor information when deleting the cursor] in the [Environmental Setting] window ([System 

Information])
➟5.2.5 ■4 [System Information]

• Turning on GS450.b3
➟12.1.3 GOT special register (GS)

Display status Base screen No. 0
Data format of the screen switching device

BIN BCD

Displaying other than user-created 
screens (such as the utility)

Not existent -1 Stores the number of the user-created 
base screen previously displayedExistent -2

Screen switching
Not existent 0*1 0*1

Existent -1*1 9999*1*2

Displaying base screen
Not existent 1 to 32767 1 to 9999

Existent 0 to 32767 0 to 9999

Display status
Data format of the screen switching device

BIN BCD

Not displayed or during screen switching

When you select [Retain the screen number of on-screen] in the [Environmental Setting] 
window, the screen number of the screen displayed before the screen switching is stored.
➟5.2.5 ■4 [System Information]
For other than the above, the value set to [Screen No. of the window screen to be hidden] in the 
[Environmental Setting] window is stored.
➟5.2.1 ■5 [Screen Switching/Window]

Displaying base screen 0 to 32767 1 to 9999
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(19)Current cursor display user ID
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
This signal stores the user ID number of a numerical input object with the cursor being displayed.
To use this signal for a text input object, configure one of the following settings.

• Selecting [Output object ID of Text Input to the system information device] for the [Environmental Setting] window 
([System Information])

• Turning on GS450.b2
For GT21 and GS21
This signal stores the user ID number of a numerical input object or a text input object with the cursor being displayed.

To store 0 when the cursor is deleted, set any of the followings.
• Selecting [Clear the cursor information when deleting the cursor] in the [Environmental Setting] window ([System 

Information])
➟5.2.5 ■4 [System Information]

• Turning on GS450.b3
➟12.1.3 GOT special register (GS)

(20)Previous cursor display user ID
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
This signal stores the user ID number of a numerical input object with the cursor displayed previously.
To use this signal for a text input object, configure one of the following settings.

• Selecting [Output object ID of Text Input to the system information device] for the [Environmental Setting] window 
([System Information])

• Turning on GS450.b2
For GT21 and GS21
The user ID of the object on which the numerical input or text input is previously displayed is stored.

To store 0 when the cursor is deleted, set any of the followings.
• Selecting [Clear the cursor information when deleting the cursor] in the [Environmental Setting] window ([System 

Information])
➟5.2.5 ■4 [System Information]

• Turning on GS450.b3
➟12.1.3 GOT special register (GS)

(21)Key code input
When inputting values with the input key (touch switch, numerical input, or text input), the specified key code is stored.
Not available to GT21 and GS21.
When a key code is stored, the Key Input signal (System signal 2-1.b3) is turned on.

➟(4) System signal 2-1

(22)External I/O function/input information 1
Use the external I/O output function for the external input.
The following shows the notification details of each bit.

Bit number Signal name Description Supported 
models

b0 to b7 Input signal X0 to X7

Input data are written. An external input can take up to three seconds to write 
data. For avoiding the delay time, use GOT internal devices (GB10 to GB25, 
GB30 to GB37, GB50 to GB57).
➟12.1.3 GOT special register (GS)

b8 Power supply signal Turns on when the power is not supplied to an external I/O device.

b9 to b15 - Use prohibited

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(23)External I/O function/input information 2
Use the external I/O output function for the external input.
The following shows the notification details of each bit.

(24)Previous numeric value input (64 bits)
When a value is input in the numerical input, the value before the change (64 bits) is stored.
Only the numerical input to which the user ID is set is effective.

(25)Current numeric value input (64 bits)
The input value (64 bits) determined in the numerical input is stored.
Only the numerical input to which the user ID is set is effective.

■2 How to use the system information

Use the system information by assigning word devices to each signal.
Setting the read device and write device is required.
For how to set the devices, refer to the following.

➟5.2.5 ■4 [System Information]
The following shows application examples of the system information.

(1) Confirm the error occurred in GOT
Not available to GT21 and GS21.
The error code of errors occurred in the GOT can be confirmed.
The error codes of error code 300 to 699 are displayed.
For details of the error codes, refer to the following.

➟GOT2000 Series User's Manual (Utility)

*1 When multiple errors occur simultaneously, the latest error code is stored.
*2 The GOT error code (write device) is not cleared automatically even if the error cause is removed.

Clear the error code by using the GOT Error Reset signal (System signal 1-1.b13).
*3 Check that the GOT Error Detection signal (System signal 2-1.b13) turns off, then turn off the GOT Error Reset signal 

(System signal 1-1.b13).
If the GOT Error Reset signal (System signal 1-1.b13) remains on, the GOT error code (write device) is reset in the next 
error occurrence.

Bit number Signal name Description Supported 
models

b0 to b7 Input signal X8 to XF

Input data are written. An external input can take up to three seconds to write 
data. For avoiding the delay time, use GOT internal devices (GB10 to GB25, 
GB30 to GB37, GB50 to GB57).
➟12.1.3 GOT special register (GS)

b8 to b15 - Use prohibited

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT status

0

Error occurred
Normal (cause of error removed) *2

OFF

ON

0 is stored.

OFF *3

ON

Error code storage *1

GOT Error Detection signal
(System signal 2-1.b13)

GOT Error Reset signal
(System signal 1-1.b13)

GOT error code
(write device)
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(2) Confirm the input key code by input key
Not available to GT21 and GS21.
The input key code can be confirmed by input key (touch switch, numerical input, or text input).

*1 When key input is completed, the stored key code is held.
When the Key Code Read Complete signal (System signal 1-1.b3) turns on, the Input key signal (System signal 2-1.b3) 
turns off.

*2 Check that the Input key signal (System signal 2-1.b3) turns off, then turn off the Key Code Read Complete signal (System 
signal 1-1.b3).
If the Key Code Read Complete signal (System signal 1-1.b3) remains on, the stored key code is reset at the next key input.

(3) Confirm the numerical input determination timing
The timing of which the input value was determined can be confirmed with the user ID written in the numerical input 
number.

*1 After the numeric value input determination, the stored user ID is held.
The Numeric Value Input signal is cleared when the Numeric Value Input Read Complete signal (System signal 1-1.b4) 
turns on.

*2 Check that the Numeric Value Input signal (write device) turns off, then turn off the Numeric Value Input Read Complete 
signal (System signal 1-1.b4).
If the Numeric Value Input Read Complete signal (System signal 1-1.b4) remains on, the user ID cannot be stored or the 
Numeric Value Input signal cannot be turned on at the next value input and determination.

Numeric value input, 
ASCII input, touch switch input

Key input

11
ON

ON
OFF

12

11 12

ON *1

OFF *2

13

Input key signal
(System signal 2-1.b3)

Key Code Read Complete signal 
(System signal 1-1.b3)

Input key code
(Write device)

0 13

Key input of the numeric 
value input

Numeric Value Input signal 
(System signal 2-1.b4)

Numeric value input number 
(write device)

ON

OFF

OFF

ON

1 2 Enter

Numeric Value Input Read 
Complete signal
(System signal 1-1.b4)

Stores the user ID

*1
*2

Stores 0
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(4) Confirm cursor's display position
The cursor's display position can be confirmed by writing the information of the object (numerical input and text input) in 
which a cursor is displayed to the device.
The following shows the object information types to be written.

• User ID Set any ID for an object. Set the user ID on setting dialog of each object.
• Object ID The ID is set automatically when an object is set with GT Designer3.

Example) Operation example of cursor display

*1 If a cursor is not displayed when the screen is switched, 0 is stored.
*2 The stored user ID and object ID are held even when a cursor is erased.
*3 If a cursor is displayed at the object (numeric input, text input) for which a user ID is not set, the cursor position numeric 

value input is 0.
*4 The current cursor display user ID and previous cursor display user ID operates with the text input when the GOT internal 

device GS450.b2 turns on.

(5) Delete the stored user ID and object ID when a cursor is deleted
To store 0 when the cursor is deleted, set any of the followings.

• Selecting [Clear the cursor information when deleting the cursor] in the [Environmental Setting] window ([System 
Information])

➟5.2.5 ■4 [System Information]
• Turning on GS450.b3

➟12.1.3 GOT special register (GS)

User ID: 15
Object ID: 10000

50

User ID: None
Object ID: 10001

1200

1) Cursor is displayed 2) Cursor is erased

50 50

12001200

3) Cursor is displayed

1200

50

Cursor status

Current cursor display user ID 
(write device)

Current cursor display object ID 
(write device)

Previous cursor display object ID 
(write device)

When the screen is switched *1

1) Display

0

Stored user ID

Stored object ID

Stored object ID

15

10000

0

2) Erase *2
3) Display

0*3

10001

10000

0
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(6) Control screens
(a) Disable the screen saver function

The screen saver function, which is set with the GOT utility, is designed to turn off the screen display if the GOT is not 
touched within a specified time. This function prevents the screen performance from deteriorating over its operable life.
By turning on the Automatic Screen Saver Disable signal in the system information, the system information function set 
with the utility (setup) can be disabled.
Example 1) Displaying the monitor screen erased by automatic screen saver function

Example 2) Interrupting the screen saver function from starting after the time set elapses

(b) Erase screens
By turning on the Forced Screen Saver Enable signal, the monitor screen can be erased.
While this bit is on, the monitor screen is not displayed even when the GOT screen is touched.
Example) Erasing the displayed monitor screen

In addition, the monitor screen can be displayed by turning on the Forced Screen Saver Touch-Cancel signal and 
touching the screen to cancel the forced screen saver function started with the Forced Screen Saver Enable signal.
Example) Displaying the monitor screen that is forcibly erased

→

Screen is not displayed.

Turn on System signal 
1-1.b0

Screen is displayed.

No. 25 D1 10
D2 20

→

Set the screen saving time to 
30 minutes

Screen does not turns to the screen saver mode after 
30 minutes have elapsed 
(The set time is disabled and the screen keeps displaying.)

Turn on System signal 
1-1.b0

No. 25 D1 10
D2 20

No. 25 D1 10
D2 20

→

Turn on System signal 
1-1.b1

Screen disappears.

No. 25 D1 10
D2 20

Screen disappears.

Turn on System signal 
1-1.b1
→

No. 25 D1 10
D2 20

No. 25 D1 10
D2 20

Turn on System signal 
1-1.b2
→

The screen appears when the GOT 
screen is touched.
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(c) Display control by human sensor
The human sensor is a function that cancels the screen saver mode without the touch operation to the GOT.
By approaching the GOT, the screen saver mode can be canceled.

When no operator is not around the GOT for the time set in the human sensor OFF delay, the Human Sensor Detection 
signal (System signal 2-1.b5) turns off.
When the time set for the screen saving time elapses after the Human Sensor Detection signal turns off, the GOT turns 
to the screen saver mode.
Configure the human sensor settings (including the human sensor detection sensitivity and the human sensor OFF delay) 
with the GOT utility.
For the details of the utility setting, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(d) Cancel the screen saver mode only when human movement is detected
By disabling the GOT to cancel the screen saver mode with the touch or external operation, the GOT cancel the screen 
saver mode only when human movement is detected.

To control the screen saver mode, use a sequence program to link the Human Sensor Detection signal with the Automatic 
Screen Saver Disable signal.
With this setting, the GOT turns the screen saver mode after the human sensor OFF delay time elapses, regardless of 
the screen saving time.

Operator motion
(Human sensor detection 
sensitivity)

Human Sensor Detection signal
(System signal 2-1.b5)

Approach Go away Approach Go away

ON
OFF

Human sensor
 OFF delay

Screen saver

Screen saving is canceled.
Screen saving 
status

Screen saving time

Human sensor 
OFF delay

Operator motion
(Human sensor detection 
sensitivity)

Human Sensor Detection signal
(System signal 2-1.b5)

Approach Go away Approach Go away

ON
OFF

Human sensor 
OFF delay

Human sensor 
OFF delay

Screen saver

Screen saving is canceled.
Screen saving 
status

OFFAutomatic Screen Saver 
Disable signal
(System signal 1-1.b0)

ON
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■3 Precautions

(1) Using a special register of the PLC
Do not use a special register of the PLC as a read device or write device of the system information.
The special register is an internal register whose specification is defined in the PLC.
If the special register is used, the PLC or the GOT may not operate correctly.

(2) Writing data to the system information device (write device)
Do not write data to a device set as a write device for the system information.
Depending on the operation on the GOT and the GOT internal status, the value of a write device may be overwritten with 
data retained in the GOT.

(3) When using global labels for the system information (write device)
When using global labels for the system information (write device), set the array-type global labels.
If a primitive data type global label is set, the system alarm (315: Device writing error) occurs.

■4 [System Information]

With [System Information], set the validity for each system information.
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display this window.

1) [Use System Information]
Select this item to enable the system information.

2) [First Device] (Read)
Set a read device where the system information (read) is stored.
The word device is available.
Up to contiguous 3 points of devices from the set device are used for the read device.

3) [Select/Sort] button
Displays the [Selection/Sort Setting] dialog.
Set the system information and order of the read device to be enabled.

➟5.2.5 ■5 [Selection/Sort Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

4)

5)
6)

7)

8)
9)

10)
11)

For GT21-P
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4) Selected item list (read device)
Displays the enabled system information and the read device assigned to each system information in a list.

5) [First Device] (Write)
Set a write device where the system information (write) is stored.
The word device is available.
Up to contiguous 39 points of devices from the set device are used for the write device.

6) [Select/Sort] button
Displays the [Selection/Sort Setting] dialog.
Set the system information and order of the read device to be enabled.

➟5.2.5 ■5 [Selection/Sort Setting] dialog
7) Selected item list (write device)

Displays the enabled system information and the write device assigned to each system information in a list.
8) [Output object ID of Text Input to the system information device]

Outputs the object ID number of a text input object to the following system information devices when data is input 
to the object.

• Numeric Value Input Read Complete signal (System signal 1-1.b4)
• Numeric Value Input signal (System signal 2-1.b4)
• Numeric value input number
• Current cursor display user ID
• Previous cursor display user ID

For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Selecting this item outputs the object ID number of a text input object to the system information devices when data 
is input to the object.
For GT21 and GS21
Regardless of whether this item is selected, the object ID number of a numerical input object or a text input object 
is output to the system information devices when data is input to the object.

9) [Clear the cursor information when deleting the cursor]
Stores 0 in the following devices when the cursor is deleted.

• Current cursor display object ID
• Previous cursor display object ID
• Current cursor display user ID
• Previous cursor display user ID

10) [Retain the screen number of on-screen (not fill in zeros)]
Holds the following device values while the screens are switched. (0 is not stored.)

• On-screen base screen number
• On-screen window 1 screen number
• On-screen window 2 screen number
• On-screen window 3 screen number
• On-screen window 4 screen number
• On-screen window 5 screen number

11) [Backlight color selection for 3-color control]
Select the backlight color of GT21-P.

• [White/Red/Pink]
• [Green/Red/Orange]
5. COMMON SETTING
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■5 [Selection/Sort Setting] dialog

In the [Selection/Sort Setting] dialog, set targets to be enabled and the order of devices.
Display this window from the [Environmental Setting] window ([System Information]).

1) [Option Refinement]
Narrows down the items displayed in [Options].
This item is displayed only when a write device is set.
The following shows the items to be selected.

• [All]: Displays all items.
• [Basic Setting]: Displays only items related to the basic setting.
• [Drive Setting]: Displays the items only related to the free space of the drives.
• [Screen Setting]: Displays only items related to the base screen and the window screen.

2) [Options]
Items to be disabled with the system information are displayed in a list.
Click the buttons on the window to move the item to [Target Items].

3) [Target Items]
Items to be enabled with the system information are displayed in a list.
Contiguous devices are assigned to the items in the list from the top.
By clicking the buttons on the window, items can be moved to [Options] or the display oder of the items can be 
changed.
The display order of the following items is fixed.

• Drive N empty capacity information(32bit) 
• Previous Numeric Value Input(64bit)
• Current Numeric Value Input(64bit)

4) Buttons
Selects, deletes, or changes the order of the display.

Item Description

[Select] button Moves an item selected in [Options] to [Target Items].

[Delete] button Moves an item selected in [Target Items] to [Options].

[Up] button Moves up an item selected in the target items.

[Down] button Moves down an item selected in the target items.

[Select All] button Moves all items displayed in [Options] to [Target Items].

[Delete All] button Moves all items displayed in [Target Items] to [Options]. However, the System signal 1-1 
(read device) and the System signal 2-1 (write device) are not moved.

[Reset] button Resets [Options] and [Target Items] to the initial status.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)

1)

2) 3)
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■6 Relevant settings

Set the relevant settings other than the specific settings for the system information as required.
The following shows the functions that are available by the relevant settings.

(1) Internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Specifying the unit of the drive free space GS466
5. COMMON SETTING
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5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

➟■1 Specifications of the screen security
■2 Precautions
■3 [Security] ([Screen Security] tab)
■4 Level authentication
■5 Operator authentication

Set a security level for objects and windows to control the screen display.
Security setting is available as shown below.

• For objects
You can set a security level for individual objects placed on the screen.
For numerical input, numerical display, text input, and text display, you can set different security levels for input 
objects and display objects.

➟8. OBJECT FUNCTION
• For base screens, window screens, and mobile screens

You can set a security level for the screen itself.
➟2.7 Changing Screen Property

The following authentication methods are selectable.
• Operator authentication

Set a security level for each operator. Authentication is performed for each operator.
➟5.2.7 Configuring the security settings for the GOT screen ([Screen Security] (Operator authentication))

• Level authentication
Set a password for each security level. Authentication is performed using the password.

➟5.2.8 Configuring the security settings for the GOT screen ([Screen Security] (Level authentication))

Example) GOT screens at login with operator accounts with different security levels

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT screen

GOT screen

GOT screen

Operator 
(security level 10)

Operator 
(security level 5)

Operator 
(security level 3)

Window
(security level 10)

Text
(Security cannot be set)

Object
(security level 5)

Object
(security level 10)

348B348B

Line No.1

A 1254A 1254

555C555C

348B348B

Line No.1

A 1254A 1254

555C555C

348B348B

Line No.1

A 1254A 1254

555C555C

Line No.1
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■1 Specifications of the screen security

(1) Operations restricted by the screen security
The screen security restricts the following operations.

• Displaying screen data and operating objects on the GOT
To restrict operations other than the above, use the following security functions.
Using multiple security functions in combination further strengthens the security.

(a) Function restricting project operations

(b) Function restricting communication with the GOT

(c) Function restricting the GOT operations

(2) Authentication method
The following two authentication methods are available: operator authentication and level authentication.
The operator authentication is performed based on the operator management information corresponding to each 
operator.
For the details, refer to the following.

➟5.2.7 Configuring the security settings for the GOT screen ([Screen Security] (Operator authentication))
The level authentication is performed using user-specified passwords corresponding to each security level.
For the details, refer to the following.

➟5.2.8 Configuring the security settings for the GOT screen ([Screen Security] (Level authentication))

■2 Precautions

When designing screens, do not set security to the initial screen appearing upon startup of the GOT. You can use the 
screen switching function or others to switch the initial screen to a screen with security.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Description

Security key authentication
Restricts a project to be viewed on GT Designer3 or executed on the GOT by protecting the project with 
a security key.
➟2.12 Protecting a Project with a Security Key

Project security
Restricts unregistered users to view or edit a project by registering users with the project. Also restricts 
operations by screen according to the access level of each user.
➟2.13 Protecting a Project by Registering Users

Function Description

Data transfer security
Restricts data transfer between the personal computer (GT Designer3) and the GOT with a password.
➟5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

IP filter
Restricts access to the GOT by Ethernet by registering IP addresses with the filtering list.
➟5.4.3 Setting the IP filter

Function Description

Functional operation security
Restricts the display of the utility, and operations of some monitor functions.
➟5.2.9 Configuring the security settings for operations in the utility ([Functional Operation Security])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [Security] ([Screen Security] tab)

Set the security for the GOT in [Security].
Select [Common] → [GOT Environmental Setting] → [Security] from the menu to display this window.
Display the [Screen Security] tab and select the authentication method used in [Authentication Method].

1) [Authentication Method]
Select the authentication method for the screen security.
The following shows selectable items.

• [None]
The screen security is not used.

• [Level]
The level authentication is an authentication method with a password set for each security level.
➟■4 Level authentication

• [Operator]
The operator authentication is an authentication method with the operator management information set for 
each operator.
➟■5 Operator authentication

■4 Level authentication

1) [Security Level Device]
Set the device to which the security level value of the screen displayed on the GOT is stored.
Set the device to set a password for each security level in [Security Level Password].
To change the security level, change the level device value from a controller.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

1)

2)
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2) [Security Level Password]
The authentication password for each security level is displayed in a list.
The password is displayed in [********].
Select the security level and click the [Edit] button. The password of the selected security level can be edited.
When registering a new password, the [Password Setting] dialog appears.

When changing the password, the [Editing password] dialog appears.

Select the security level and click the [Delete] button. The password of the selected security level can be deleted.
When deleting the password, inputting the current password is not required.

• [Level]
Displays the security level for the password.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

• [Level]
Displays the security level for the password.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.
5. COMMON SETTING
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■5 Operator authentication

1) [Store operator ID to the device]
Set a device to store the operator ID of a login operator (operator ID external notification device).
The word device and bit device specified as a word device are available.
The specified device stores 0 when the operator logs out.

2) [Store operator name to the device (8 points)]
Set a device to store the operator name of a login operator (operator name external notification device).
The word device and bit device specified as a word device are available.
Setting the device reserves 8 points of the word device or 128 points of the bit device.
If the operator name contains less than 16 characters, blank devices store 0.
All the devices store 0 when the operator logs out.

3) [Store the operator security level to the device]
Set a device to store the security level of a login operator (operator level external notification device).
The word device and bit device specified as a word device are available.
The specified device stores 0 when the operator logs out.

4) [Externally control the security level]
Set a device to change the security level of the login operator externally (security level external control device).
The word device and bit device specified as a word device are available.

➟5.2.7 ■1 (8) Security level control from an external device
5) [Externally control the operator authentication]

Set a device to control the operator authentication externally (operator authentication external control device).
The word device and bit device specified as a word device are available.

➟5.2.6 ■5 (1) (1) Operator authentication external control device
6) [Screen Setting for Logout]

Set a screen displayed when logging out of the GOT.
Select each window screen to set a window screen displayed when logging out of the GOT.
To set a window screen, set the screen switching device.
Timing to display the set screen differs according to operation when logging out of the GOT.

• Logging out of the GOT by a touch switch (special function switch) or the automatic logout function
After logging out of the GOT, the set screen appears.

• Logging out of the GOT by the utility
After logging out of the GOT, the utility screen appears.
After changing the utility screen to a user-created screen, the set screen appears.

1)

6)

5)
4)
3)
2)

8)
7)

9)
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7) [Display log-in completion notification]
Not available to GT23, GT21, GT SoftGOT2000, and GS21.
Displays the login completion notification dialog when logging in the GOT.

8) [Auto Close Setting]
Not available to GT23, GT21, GT SoftGOT2000, and GS21.
Closes the login completion notification dialog automatically.
Set the time period between displaying the login completion notification dialog and closing the dialog.
The setting range is [1] to [60] second(s).

9) [Screen Switching] button
Displays the [Screen Switching/Window] of the [Environmental Setting] window.

➟5.2.1 ■5 [Screen Switching/Window]

(1) Operator authentication external control device

Security level after the forced logout
When an operator security level becomes lower than the one set for the currently-displaying screen after the 
forced logout, each screen operates as follows.

• Base screen
The login screen is displayed.

• Window screen
The window screens (overlap windows and superimposed windows) are deleted.

Bit number Signal name Description

.b0 Forced Logout signal

Turning on this signal forcibly logs out an operator currently logging in.
The Forced Logout signal operates at the signal rising. 
Therefore, this signal does not operate even if it is always turned on. 
Also, without the user login, this signal does not operate even if it is turned on.
Before turning off this signal, check that the Operator ID External Notification device stores 0.

.b1 to .b15 - Use prohibited
5. COMMON SETTING
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5.2.7 Configuring the security settings for the GOT screen ([Screen Security] 
(Operator authentication))

■1 Specifications of the operator authentication

The operator authentication is performed based on the operator management information corresponding to each 
operator.
To record the operator login information, use the operation log function in combination.
To strengthen the security, set the automatic logout and the password expiration date.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen display with the security 
level 10

348B348B

Line No. 1
A 1254A 1254

555C555C

348B348B

Line No. 1
A 1254A 1254

555C555C

Screen display with the security
 level 5

Line No. 1

Screen display with the security 
level 3

348B348B

Line No. 1
A 1254A 1254

555C555C

Operator name: TARO
Password: Eagle-010

Security level: 10

Operator name: JIRO
Password: Penguin-005

Security level: 5

Operator name: SABURO
Password: Pigeon-003

Security level: 3

Objects with the security
level 10

Objects with the security 
level 5
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(1) Authentication type
The operator authentication includes the following authentication types.

(a) Authentication with a password
The operator is authenticated with an operator name and password that are input by the operator.

(b) Authentication with an external authentication device
The operator is authenticated with the external authentication ID that is input using an external authentication device.
For the usable external authentication devices, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-
0160)

Cancel

Input the operator name and 
the password.

Operator name     : TARO
Password             : MITSUBISHI

Authentication succeeds!

Input the external authentication ID 
from an external authentication device.

External authentication ID: 98760001

RFID tag RFID controller GOT

Operator name: TARO
External authentication ID: 98760001

Authentication succeeds!

An operator authentication 
succeeded.

OK

Example) When using an RFID controller as an external authentication device
5. COMMON SETTING
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(2) Operator management information
The operator management information is the information to determine and authenticate the login operator, which includes 
the operator name and the password.
The following shows the number of pieces of operator management information registrable for one project.

• GT27, GT25, GT SoftGOT2000, and GS25: 1000 pieces
• GT23, GT21, and GS21: 255 pieces

Input the operator management information with the [Operator information management] screen of the utility or a 
personal computer.
For inputting the operator management information from the GOT utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)
For editing the operator management information on a personal computer, refer to the following.

➟■4 Editing the operator management information on a personal computer
The following shows the detailed operator management information.

You can export the set operator management information to the data storage and import to other GOTs.
By using the operation log function together at the operator authentication setting, you can store the operator's 
information (operator name and operator ID) as a history.

Item Description

Operator name

Name to identify an operator.
Up to 16 uppercase and lowercase alphabetic characters, numbers, one-byte spaces, and the 
symbols below are usable for an operator name.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~
(The administrator name is fixed to [Administrator].)

Operator ID
ID number assigned to an operator.
The setting range is 1 to 32766.
(The administrator ID number is fixed to [-].)

Password

Password for the operator to log in the GOT.
Up to 32 uppercase and lowercase alphabetic characters, numbers, one-byte spaces, and the 
symbols below are usable for a password.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~
You are recommended to set an unpredictable password consisting of uppercase and lowercase 
alphabetic characters, numbers, and symbols.

External authentication ID

ID number to be input from an external authentication device when an operator is authenticated 
with the device.
This item cannot be set for the administrator account.
The setting range is 4 to 32 digits (up to 8 words) in hexadecimal.
If you do not use an external authentication device, this setting is unnecessary.

Security level
Security level set for an operator.
This item cannot be set for the administrator account.
The setting range is [0] to [15].

Password expiration date setting
Set whether to enable or disable the password expiration date.
This item cannot be set for the administrator account.

Disabling an operator account

Not available to GT21 and GS21.
Set whether to disable an operator account.
The disabled operator account is not usable for login.
(The administrator account or a sub administrator account can be disabled.)

Changing a password at the next login

Not available to GT21 and GS21.
Set whether to display a message prompting for a password change at the next login.
The message does not appear after the password change.
This setting prompts each operator to change the initial password set by the administrator.

Administrator privileges
Not available to GT21 and GS21.
Set whether to grant administrator privileges to an operator.
An operator with administrator privileges becomes a sub administrator.

Password history
Not available to GT21 and GS21.
The specified number of passwords used are saved.
The setting range is [0] (Invalid), or [1] times to [5] times.
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(3) Administrator and sub administrator
Administrator refers to the account preset in the GOT for management use only.
(Operator name: Administrator, operator ID number: -)
The administrator can register, edit, or delete the operator management information on each operator.
The administrator can also change the function setting for the operator authentication in the utility.
However, the administrator cannot log in as an operator to perform operations on the GOT.

Sub administrator refers to an operator with administrator privileges.
GT21 and GS21 do not support the use of sub administrators.
The sub administrator can register, edit, or delete the operator management information on an operator having a lower 
security level.
The sub administrator can also change the function setting for the operator authentication in the utility.
To enable the use of sub administrators, configure the relevant setting in [Function setting] in the utility.
For the setting, refer to the following.

➟GOT2000 Series User's Manual (Utility)
To grant administrator privileges to an operator, set the operator management information on the operator.
For the details of the operator management information, refer to the following.

➟(2) Operator management information
To change the operator management information, function setting, or other settings with administrator privileges, the 
administrator password authentication is required.
This authentication is required even when a logged-in sub administrator tries to change the above settings.
The following shows the utility settings changeable by the administrator or sub administrators.
(○: Available, ×: Not available)

*1 A sub administrator can manipulate the operator management information on an operator having a lower security level.
*2 To set this item, a sub administrator must have security level 15.
*3 A sub administrator having a security level lower than the level specified in [Allow function setting] cannot configure the 

settings.

(4) Password expiration date
You can set an expiration date for a password.
Set the password expiration date in [Function setting] (Operator authentication) in the utility.
For how to set the expiration date for the password, refer to the following.

➟GOT2000 Series User's Manual (Utility)
You can enable or disable the set password expiration date for each operator by using the setting of the operator 
management information.
For the details of the operator management information, refer to the following.

➟(2) Operator management information

Settings in the utility Administrator
Sub administrator

When [Allow function 
setting] is selected

When [Allow function 
setting] is deselected

Operator 
management

Registering, editing, or deleting the operator 
management information ○ ○*1 ○*1

Editing the operator management information on 
the administrator ○ ○*2 ×

Function setting

Settings other than the administrator setting ○ ○*3 ×

Administrator 
setting

Enabling the use of sub 
administrators ○ × ×

Displaying uneditable 
operator information ○ ○*2 ×

Allowing the function setting 
to be changed ○ × ×

Security level required to 
change the function setting ○ ○*2 ×
5. COMMON SETTING
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(5) Password expiration prenotification
Not available to GT21 and GS21.
You can display a dialog prenotifying the password expiration date at login.
Set the password expiration prenotification in [Function setting] (Operator authentication) in the utility.
For setting the password expiration prenotification, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(6) Saving the password history
Not available to GT21 and GS21.
The history of passwords used is saved.
When saving the password history is enabled, you cannot set the same password as the one saved in the history.
Enable saving the password history in [Function setting] (Operator authentication) in the utility.
For the setting procedure, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(7) Automatic logout
You can set operator accounts to automatically log out after a certain period of inactivity.
Set the automatic logout in [Function setting] (Operator authentication) in the utility.
For how to set the automatic logout, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(8) Security level control from an external device
You can control the security level of the targets that can be displayed by the operator who is logged in the GOT from an 
external device.
Store the security level value to the security level external control device to change the security level of the operator.
In this case, the new security level is not reflected to the relevant operator management information.
When this setting is enabled, the security level specified in the operator management information becomes invalid.

To enable the security level control from an external device, select [Externally control the security Level] in the [Screen 
Security] tab in [Security] of the [Environmental Setting] window.
Then, set the security level external control device.

➟5.2.6 ■5 ■5 Operator authentication

(9) Forced logout
When the operator authentication external control device is set, operators can be forcibly logged out by turning on the 
Forced Logout signal (.b0).
For how to set the operator authentication external control device, refer to the following.

➟5.2.6 ■5 Operator authentication

(10)Auxiliary authentication
For the operator authentication with an external authentication device, the operator authentication may not be properly 
executed due to an error such as a device failure.
Enable the auxiliary authentication beforehand so that the authentication is executed by switching to the operator 
authentication with a password.
For how to set the auxiliary authentication, refer to the following.

➟GOT2000 Series User's Manual (Utility)

348B348B

Line No. 1
A 1254A 1254

555C555C

Objects with the security 
level 10

Security level
5 → 10

Security level external 
control device
D500: 5 → 10

Operator name: SABURO
Password: Pigeon-003

Security level: 3 Invalid

The security level of the screen display 
changes corresponding to the value of D500, 
however, the operator management information 
is not changed.
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(11)Block of login due to incorrect login attempts
Not available to GT21 and GS21.
When login attempts fail consecutively more than the specified number of failed login times ([Invalid login count]) within 
five minutes, the GOT recognizes an incorrect login.
In such a case, all operators cannot log in to the GOT until the login block time elapses.
To unblock the login before the lapse of the block time, perform the administrator password authentication with the 
administrator account or a sub administrator account.
Set the invalid login count and the login block time in [Function setting] (operator authentication) in the utility.
For the setting, refer to the following.

➟GOT2000 Series User's Manual (Utility)
You can check whether the login is blocked due to incorrect login attempts with a GOT special register (GS).
When the login is blocked within the login block time period, GS242.b0 (Incorrect Login signal) is on.
For the details of GS242 (Incorrect Login signal), refer to the following.

➟12.1.3 ■2 (43) Incorrect Login (GS242)

(12)Lock of an operator account due to incorrect login attempts
Not available to GT21 and GS21.
If an operator consecutively fails to log in more than the specified number of failed login times ([Operator lock count]), the 
operator account is locked.
The locked operator account is not usable for logins until the administrator or a sub administrator unlocks this account.
Set the operator lock count in [Function setting] (operator authentication) in the utility.
Unlock an operator account in [Operator information management] (operator authentication) in the GOT utility.
For the setting, refer to the following.

➟GOT2000 Series User's Manual (Utility)
You can check whether an operator account is locked with a GOT special register (GS).
When an operator account is locked, GS242.b1 (Operator Locked signal) is on.
For the details of GS242 (Incorrect Login signal), refer to the following.

➟12.1.3 ■2 (43) Incorrect Login (GS242)

(13)Password requirements
Not available to GT21 and GS21.
You can set the minimum number of characters and the character types as password requirements.
For setting the password requirements, refer to the following.

➟GOT2000 Series User's Manual (Utility)
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■2 Operator authentication setting

To perform the operator authentication, configure the relevant settings in the project and the utility.

(1) Setting on GT Designer3
Step 1 Configure the setting in the project on GT Designer3.

Open the [Security] setting screen of the [Environmental Setting] window. Select [Operator] for 
[Authentication Method] of the [Screen Security] tab.
Configure other settings and set various devices as necessary.

➟■3 [Security] ([Screen Security] tab)
5.2.7 ■6 Relevant settings

Step 2 To use an external authentication device, configure the settings as shown below.
• When using an RFID controller, set the RFID controller for channel No. 8 and select [Use RFID] in the 

[RFID] dialog.
➟10.2.5 [RFID] dialog

• When using a USB device, select [Use USB Bar Code] in the [Bar Code] dialog and turn on b1 of 
[Control Device].
GT SoftGOT2000 does not support authentication with a USB device.
➟10.1.5 ■2 [USB] tab

Step 3 Set the security level for each screen and objects on the screens.

➟2.7.1 Property of base screens
2.7.2 Properties of window screens
8. OBJECT FUNCTION

Step 4 Install the package data on the GOT.

(2) Setting on the GOT
Step 1 At the first startup, set the administrator password.

In the [Operator information management] screen, set a password for the administrator.
Step 2 Configure the function setting for the operator authentication.

Select [GOT basic set] → [Operator Authentication] → [Function setting] from the utility main menu, and 
configure the setting in the [Function setting] screen as shown below.
For the operator authentication with a password

• [Auth method]: [Operator name + password]
For the operator authentication with an external authentication device

• [Authentication Method]
Select [External auth (serial)] or [External auth (USB)].

• [Front position]
Set the starting position of the external authentication ID in the data read from the external 
authentication device.

• [Available bite number]
Set the number of bytes for the external authentication ID.

➟GOT2000 Series User's Manual (Utility)
(Setting example of operator authentication with an external authentication device)
When the character string of the received data is as follows and the external authentication ID is [25A3B7]
   Received character string: [STX]  2  5   A   3   B   7  [ETX]
   Hexadecimal notation       :    02  32 35 41 33 42 37  03
Set the following values.
   [Initial position input]: 0
   [Valid byte count input]: 6

Step 3 Display the [Operator information management] screen from the [Operator setting menu] screen, and 
register the operator management information.
The following shows the items to set.

• Operator name
• Operator ID
• Password

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• Security level
For the details of the operator management information, refer to the following.

➟5.2.7 ■1 (2) Operator management information

■3 How to use the operator authentication

(1) Login for the operator authentication with a password
Step 1 Display the login screen.

Display the login screen by the following methods.
• Touch the special function switch to which [Log-in/Log-out (Operator Authentication)] is set.
• Display the utility and touch the [Login/Logout] button.

When the security level is inadequate for input, if you touch a special function switch for which [Switch 
Action] is set to the utility or any monitor function screen, the login screen appears.
(The touch switch does not function if its operating condition is unsatisfied.)

Step 2 The operation differs depending on the authentication type.
• Operator authentication with a password

Input the user name and a password then touch the [ENT] button.
• Operator authentication with an external authentication device

Input the external authentication ID by using the external authentication device such as an RFID.
Step 3 For the operator authentication with a password, you can log in when the correct user name and password 

are input.
For the operator authentication with an external authentication device, you can log in when the correct 
external authentication ID is input.

(2) Logout
Step 1 Perform either of the following operations.

• Touch the special function switch to which [Log-in/Log-out (Operator Authentication)] is set.
• Display the utility and touch the [Login/Logout] button.

For GT21 and GS21, log out of the operator authentication.
For any models other than GT21 and GS21, the [Confirm] dialog for logging out appears.

Step 2 To log out, touch the [Logout] button.
To switch the operator, touch the [Switch] button to display the login screen.
The current operator account is still in the logged-in state.
To cancel logging out, touch the [Cancel] button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Login screen for the operator 
authentication with a password

Login screen for the operator authentication 
with an external authentication device

[Confirm] dialog
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(3) Forced logout
You can force the operator to log out by turning on the Forced Logout signal (.b0) of the operator authentication external 
control device.
Do not leave this signal on because the forced logout is triggered with each turn-on of this signal.
For the details of the operator authentication external control device, refer to the following.

➟5.2.6 ■5 (1) Operator authentication external control device

■4 Editing the operator management information on a personal computer

With GOT Operator Management Information Conversion Tool, you can convert the operator management information 
file (AUTHINF.G2U) exported from the GOT into a CSV file.
After editing the CSV file on a personal computer, you can convert the CSV file back into AUTHINF.G2U.
Thus, you can import AUTHINF.G2U to the GOT to reflect the results of the registration, change, and deletion of operator 
management information.
With GT21 and GS21, you can convert a CSV file into an operator management information file only.

Step 1 Export an operator management information file (AUTHINF.G2U or AUTHINF.CSV) from the GOT to the 
data storage.
Display the [Operator information management] screen from the [Security setting] screen of the utility to 
export the operator management information.

➟GOT2000 Series User's Manual (Utility)
(When exporting an operator management information file in CSV format, proceed to step 3.)

Step 2 Convert the operator management information file into a CSV file on a personal computer where this tool is 
installed.

➟(4) How to convert AUTHINF.G2U into a CSV file
Step 3 Edit the operator management information by using spreadsheet software or others.

➟(8) CSV file (AUTHINF.CSV) configuration
Step 4 Convert the edited CSV file back into an operator management information file.

➟(5) How to convert a CSV file into AUTHINF.G2U
Store the operator management information file in a data storage.

Step 5 Import the operator management information file (AUTHINF.G2U) from the data storage to the GOT.
Display the [Operator information management] screen from the [Security setting] screen of the utility to 
import the operator management information.

➟GOT2000 Series User's Manual (Utility)

(1) How to obtain the GOT Operator Management Information Conversion Tool
Obtain the GOT Operator Management Information Conversion Tool by one of the following methods.

• Disk5 folder in GT Works3 DVD
• Contact your local distributor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Exporting an operator management 
information file (file name: AUTHINF)

Importing the operator management
information file (AUTHINF.G2U)

Converting the operator management information 
file into a CSV file

AUTHINF

CSV

AUTHINF

G2U

Editing the operator management information 
by using spreadsheet software or others

AUTHINF

CSV

Converting the CSV file back into an operator 
management information file

AUTHINF

CSV

AUTHINF

G2U

AUTHINF

G2U

1. 2.

3.

4.5.

AUTHINF

G2U

AUTHINF

CSV
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(2) Operating environment
The following shows the operating environment for the GOT Operator Management Information Conversion Tool.

*1 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Changing your desktop themes (fonts)
• Remote desktop
• DPI setting other than the normal size (For Windows XP and Windows Vista)
• Setting the size of text and illustrations on the screen to any size other than [Small-100%] (for Windows 11, Windows 10, 

Windows 8.1, Windows 8, and Windows 7)
*2 Windows XP Mode is not supported.
*3 The touch feature is not supported.
*4 Modern UI Style is not supported.
*5 Operation in a virtual environment such as Hyper-V is not supported.
*6 For the system requirements for the OSs, refer to the following.

➟Microsoft official website

(3) How to start GOT operator management information conversion tool
Installing GOT operator management information conversion tool is not required.
Copy the execution file (GTOperatorInfoConv.exe) in a folder, and then execute the file in the folder.

(4) How to convert AUTHINF.G2U into a CSV file
Step 1 Start GOT Operator Management Information Conversion Tool to display the following dialog.

Enter the full path of the operator management information file (AUTHINF.G2U) in [Source file], and select 
[Convert operator management information file into CSV file].
Click the [Convert] button.

Item Description

Model Personal computer that Windows runs on.

OS(English version)*1*5

• Microsoft Windows 11 Education (64 bit)*3

• Microsoft Windows 11 Enterprise (64 bit)*3

• Microsoft Windows 11 Pro (64 bit)*3

• Microsoft Windows 11 Home (64 bit)*3

• Microsoft Windows 10 Enterprise (32 bit, 64 bit)*3

• Microsoft Windows 10 Pro (32 bit, 64 bit)*3

• Microsoft Windows 10 Home (32 bit, 64 bit)*3

• Microsoft Windows 8.1 Enterprise (32 bit, 64 bit)*3*4

• Microsoft Windows 8.1 Pro (32 bit, 64 bit)*3*4

• Microsoft Windows 8.1 (32 bit, 64 bit)*3*4

• Microsoft Windows 8 Enterprise (32 bit, 64 bit)*3*4

• Microsoft Windows 8 Pro (32 bit, 64 bit)*3*4

• Microsoft Windows 8 (32 bit, 64 bit)*3*4

• Microsoft Windows 7 Ultimate (32 bit, 64 bit)*2*3

• Microsoft Windows 7 Enterprise (32 bit, 64 bit)*2*3

• Microsoft Windows 7 Professional (32 bit, 64 bit)*2*3

• Microsoft Windows 7 Home Premium (32 bit, 64 bit)*3

• Microsoft Windows 7 Starter (32 bit)
• Microsoft Windows Vista Ultimate (32 bit) Service Pack1 or later
• Microsoft Windows Vista Enterprise (32 bit) Service Pack1 or later
• Microsoft Windows Vista Business (32 bit) Service Pack1 or later
• Microsoft Windows Vista Home Premium (32 bit) Service Pack1 or later
• Microsoft Windows Vista Home Basic (32 bit) Service Pack1 or later
• Microsoft Windows XP Professional (32 bit) Service Pack2 or later
• Microsoft Windows XP Home Edition (32 bit) Service Pack2 or later
• Microsoft Windows 2000 Professional Service Pack4 or later

CPU The system requirements for the above OSs must be met.*6

Memory The system requirements for the above OSs must be met.*6

Display Resolution: SVGA (800 × 600 dots) or higher

Hard disk space 500 KB or more

Display color High Color (16 bits) or higher

Other hardware Use a mouse and a keyboard compatible with the above OSs.
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Step 2 The authentication type varies with the function setting of the conversion source file.
• When the use of sub administrators is disabled in the function setting

In the [Administrator password entry] dialog, enter the administrator password and click the [OK] 
button.

• When the use of sub administrators is enabled in the function setting
In the [Administrator authentication] dialog, enter the operator name and password of the administrator 
or sub administrator, and click the [OK] button.
After authentication succeeds, a CSV file (AUTHINF.CSV) is created in the folder where the conversion 
source file is stored.

Step 3 When the use of sub administrators is disabled in the function setting, re-enter the administrator password 
and click the [OK] button in the [Administrator password re-entry] dialog.
After authentication succeeds, a CSV file (AUTHINF.CSV) is created in the folder where the conversion 
source file is stored.

(5) How to convert a CSV file into AUTHINF.G2U
If a sub administrator performs the file conversion, the conversion source file and the exported operator management 
information file (AUTHINF.G2U) must be stored in the same folder before the conversion.
Otherwise, the file conversion cannot be performed.

Step 1 Start GOT Operator Management Information Conversion Tool to display the following dialog.
Enter the full path of a CSV file (AUTHINF.CSV) in [Source file], and select [Generate operator management 
information file from CSV file] or [Generate operator management information file from CSV file(GT21)].
Click the [Convert] button.

When the use of sub administrators is disabled

When the use of sub administrators is enabled
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Step 2 The authentication type varies with the configuration of the CSV file specified in [Source file].
• When [SUB_ADMIN_FORMAT] is nonexistent in the header part of the CSV file

In the [Administrator password entry] dialog, enter the administrator password and click the [OK] 
button.

• When [SUB_ADMIN_FORMAT] is existent in the header part of the CSV file
In the [Administrator authentication] dialog, enter the operator name and password of the administrator 
or sub administrator, and click the [OK] button.
The contents of the CSV file are imported to the operator management information file (AUTHINF.G2U) 
stored in the same folder.

Step 3 When [SUB_ADMIN_FORMAT] is nonexistent in the header part of the CSV file, re-enter the administrator 
password and click the [OK] button in the [Administrator password re-entry] dialog.
An operator management information file (AUTHINF.G2U) is created in the same folder.

(6) Setting items of GOT Operator Management Information Conversion Tool

1) [Generate operator management information file from CSV file] (GT27, GT25, GT23, GT 
SoftGOT2000, and GS25)
Converts a CSV file into an operator management information file.
Clicking the [Convert] button performs the operation according to the contents of the CSV file.
• When [SUB_ADMIN_FORMAT] is nonexistent in the header part of the CSV file

The CSV file specified in [Source file] is converted into an operator management information file.
• When [SUB_ADMIN_FORMAT] is existent in the header part of the CSV file

The contents of the CSV file specified in [Source file] are imported to the exported operator management 
information file.
Before the conversion, make sure to store the CSV file and the exported operator management information file in 
the same folder.
After the conversion, a log file is output.

2) [Convert operator management information file into CSV file]
Converts an operator management information file into a CSV file.
Select this item and click the [Convert] button to convert the operator management information file specified in 
[Source file] into a CSV file.

When [SUB_ADMIN_FORMAT] is nonexistent

When [SUB_ADMIN_FORMAT] is existent

1)
2)
3)

4)
5)
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After the conversion, the CSV file and the conversion source file are stored in the same folder.
3) [Generate operator management information file from CSV file(GT21)] (GT21 and GS21)

Converts a CSV file into an operator management information file.
After the conversion, a log file is output.

4) [Sourse of Conversion]
Specify a path of the conversion source file.
By clicking the [Brouse] button, the path of the conversion source file can be specified in the [Open CSV file] dialog.

5) [Convert] button
Executes the file conversion.

(7) Operation with a command line
You can operate GOT Operator Management Information Conversion Tool with Command Prompt.
Perform one of the following operations to open Command Prompt.

• Select [Windows System] → [Command Prompt] from the Windows start menu.
• Enter "cmd" in the search box on the taskbar, and run a search.

Command Prompt opens differently depending on the Windows OS.
Describe a command line in the following formats.
GTOperatorInfoConv.exe filename [password] [/f] [/l] [/-c] [/s operator name] [/help] [/?]
(The options in square brackets are omittable.)

(8) CSV file (AUTHINF.CSV) configuration
A CSV file consists of the header part and the data part.
Set each setting item without changing the order of the items.

➟(9) Header part
(10) Data part

When a sub administrator converts a CSV file into AUTHINF.G2U, the items uneditable by the sub administrator are not 
output.
In the following cases, the data format is invalid and a CSV file is not converted into an operator management information 
file.

• A necessary setting item is deleted.
• The order of the setting items is changed.

Type Format Description

Command GTOperatorInfoConv.exe

The file conversion is performed as shown below.
• Converting AUTHINF.G2U into a CSV file

The conversion source file and the CSV file are stored in the same folder.
• Converting a CSV file (without [SUB_ADMIN_FORMAT]) into AUTHINF.G2U

An operator management information file (AUTHINF.G2U) is created in the 
folder where the conversion source file is stored.

• Converting a CSV file (with [SUB_ADMIN_FORMAT]) into AUTHINF.G2U
The contents of the CSV file are imported to the operator management 
information file (AUTHINF.G2U) stored in the same folder.

After the conversion, another command prompt window appears, displaying the 
conversion result.

Option

filename
Specifies the operator management information file to be converted (CSV or 
G2U) with the absolute path. If the path contains spaces, enclose the path in 
double quotation marks (" ").

password Specifies the administrator password.

/f

If the conversion destination folder already has a file with the same name, the file 
is overwritten.
When the contents of a CSV file is imported to the exported operator 
management information file (AUTHINF.G2U), this option is invalid.

/l

Outputs the conversion result to an operator management information conversion 
log file.
The operator management information conversion log file is output to the folder 
where the conversion source file is stored.
If the folder already has a file with the same name as that of the operator 
management information conversion log file, the file is overwritten.

/-c Does not start the command prompt to display the conversion result.

/s operator name
Specifies a sub administrator to execute the file conversion.
After "/s", enter the operator name of the sub administrator.

/help Displays how to use options on the command prompt.
If these options are specified, the other options are ignored and the conversion is 
not executed./?
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• Any of the settings is incorrect.
• An unnecessary item exists.

(9) Header part
In the header part, configure the common setting for each operator information.
Items to be output vary with the settings, such as administrator privileges.

1) [GOT_OPERATOR_AUTHENTICATION_INFO]
Keyword to declare that the file is an operator management information file for GT27, GT25, GT23, GT 
SoftGOT2000 or GS25.
When the file is an operator management information file for GT21 or GS21, the item name is 
[GOT_OPERATOR_AUTHENTICATION_INFO_GT21].

2) [DATA_VERSION]
Data structure version of the CSV file.
The data structure version varies with the version of the GOT Operator Management Information Conversion Tool 
used.

3) [SUB_ADMIN_FORMAT]
Not available to GT21 and GS21.
Keyword to indicate the information on a sub administrator.
After the keyword, the operator name and security level of the sub administrator who has performed the file 
conversion are output.
The operator name is output in the following format: [USER:Username].
The security level is output in the range from [0] to [15].
When the administrator converts AUTHINF.G2U into a CSV file, this item is not output.

4) [AUTH_TYPE]
Set the authentication type of the operator authentication.
Set either of the following.

• [ID_PASS]: Performs the operator authentication with a password.
• [EXT_AUTH]: Performs the operator authentication with a serial device.
• [EXT_AUTH+P]: Performs both the operator authentication with a serial device and the auxiliary authentication.
• [EXT_AUTHUSB]:

Only available to GT2107-W for GT21.
Performs the operator authentication with a USB device.

• [EXT_AUTHUSB+P]:
Only available to GT2107-W for GT21.
Performs both the operator authentication with a USB device and the auxiliary authentication.

When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

5) [PASS_TYPE]
Set the password type.
Set either of the following.

1)
2)

3)
4)

5)
6)

7)
8)

9)
10)

11)
12)

13)
14)

15)
16)

17)
18)

19)
20)

21)
22)

23)
24)

25)
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• [ENCRYPTED]
Set this item to specify an encrypted password.
An unencrypted password is encrypted when AUTHINF.G2U is converted into a CSV file.

• [PLAIN]
Set this item to specify an unencrypted password.

6) [AUTO_LOGOUT_TIME]
Set the automatic logout time.
The setting range is [0] (Invalid) minutes to [60] minutes.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

7) [PASS_EXP_DATE]
Set the password expiration date.
The setting range is [0] (Invalid) days to [1000] days.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

8) [EXT_AUTH_ID_TOP]
Set the starting position of the external authentication ID.
The setting range is [0] to [1998] bytes.
When a CSV file is converted into an operator management information file, [0] is set in the following case.

• When nothing or invalid value is set
The total set value of [EXT_AUTH_ID_TOP] and [EXT_AUTH_ID_LEN] must be 2000 or less.
If the total set value exceeds 2000, the file cannot be converted correctly.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

9) [EXT_AUTH_ID_LEN]
Set the number of bytes for the external authentication ID.
The setting range is [2] to [16] bytes.
When a CSV file is converted into an operator management information file, the set value varies depending on the 
case as shown below.

• When nothing or invalid value is set: 4
The total set value of [EXT_AUTH_ID_TOP] and [EXT_AUTH_ID_LEN] must be 2000 or less.
If the total set value exceeds 2000, the file cannot be converted correctly.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

10) [EXT_UNIT_CH]
Set the channel for connecting an external authentication device.
The setting range is [8].
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

11) [LOGIN_LOCK_NUM]
Set the number of consecutive failed login attempts for the GOT to recognize an incorrect login.
The setting range is [0] (Invalid), or [3] times to [10] times.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

12) [LOGIN_LOCK_CANCEL_TIME]
Set the time period in which all operator accounts except the administrator one are locked upon an incorrect login.
The setting range is [1] (second) to [3600] (seconds).
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

13) [LOGIN_LOCK_TIME]
Set the time period in which consecutive failed login attempts increment the failed login count.
The settable value is [5] minutes. (Fixed)
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

14) [OPE_LOCK_NUM]
Set the number of consecutive failed login attempts to an operator account for the GOT to recognize an incorrect 
login.
The setting range is [0] (Invalid), or [3] times to [10] times.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
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file, this item is not output.
15) [OPE_LOCK_TIME]

Set the time period in which consecutive failed login attempts to an operator account increment the failed login 
count.
The settable value is [5] minutes. (Fixed)
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

16) [PASS_REQ_FLG]
Set whether to enable the password requirement setting.

• [0]: Disabled
• [1]: Enabled

When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

17) [PASS_REQ_MIN_LENGTH]
Set the minimum number of characters of a password.
The setting range is [1] character to [32] characters.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

18) [PASS_REQ_STR_TYPE]
Set the character types of a password.

When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

19) [PASS_EXP_NOTICE]
Set the number of days before password expiration to start notifying the password expiration date.
When the number of remaining days is equal to or less than the set number of days, a message prompting for a 
password change appears at login.
The setting range is [0] days (Invalid), or [1] day to [30] days.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

20) [SUB_ADMIN_FLG]
Not available to GT21 and GS21.
Set whether to enable the use of sub administrators.

• [0]: Disabled
• [1]: Enabled

When a sub administrator performs the file conversion, this item is not output.
21) [OUTPUT_ALL_OPE]

Not available to GT21 and GS21.
If a sub administrator converts AUTHINF.G2U into a CSV file, set whether to output the operator information 
uneditable by the sub administrator to the data part of the CSV file.

• [0]: Not output
• [1]: Output

When one of the following operators converts AUTHINF.G2U into a CSV file, this item is output.
• Administrator
• Sub administrator who has security level 15 and is allowed to edit the function setting

22) [IS_FUNC_SET]
Not available to GT21 and GS21.

Set value Description

[0] Does not check the character types.

[1]
Checks if a password contains the following two types of characters.
• Alphabet (A to Z and a to z)
• Numbers, symbols, and one-byte spaces

[2]

Checks if a password contains the following three types of characters.
• Alphabet (A to Z and a to z)
• Numbers
• Symbols and one-byte spaces

[3]

Checks if a password contains the following four types of characters.
• Uppercase alphabet (A to Z)
• Lowercase alphabet (a to z)
• Numbers
• Symbols and one-byte spaces
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Set whether to allow sub administrators to set the function setting.
• [0]: Not allowed
• [1]: Allowed

When a sub administrator performs the file conversion, this item is not output.
23) [FUNC_SET_LEVEL]

Set the security level of the sub administrator that can edit the function setting.
The setting range is [0] to [15].
When one of the following operators converts AUTHINF.G2U into a CSV file, this item is output.

• Administrator
• Sub administrator who has security level 15 and is allowed to edit the function setting

24) [PASS_HIST_NUM]
Enable saving the password history.
The setting range is [0] (Invalid), or [1] times to [5] times.
When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

25) [PASS_HIST_DEL_FLG]
Set whether to delete the password history when the operator management information file is imported.

• [0]: Disabled
• [1]: Enabled

When a sub administrator who is not allowed to configure the function setting converts AUTHINF.G2U into a CSV 
file, this item is not output.

(10)Data part
In the data part, set the individual operator information.

1) [OPE_ID]
Set the operator ID.
The setting range is [1] to [32766].

2) [OPE_NAME]
Set the operator name.
Up to 16 one-byte alphanumeric characters (a to z, A to Z, 0 to 9) and symbols as shown below can be used.
(Alphabets are case sensitive.)

• ! " # $ % & ' ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~
• One-byte space (However, a one-byte space used at the end of the operator name is invalid.)

When editing a CSV file directly, add [USER:] to the start of data.
Otherwise, an error occurs when the CSV file is converted to an operator management information file 
(AUTHINF.G2U).

3) [LEVEL]
Set the security level for an operator.
The setting range is [0] to [15].
When a sub administrator converts AUTHINF.G2U into a CSV file, a security level lower than that of the sub 
administrator can be set for an operator.

4) [GROUP]
Not used.
Leave the area blank.

5) [PASSWD]
Set the password for the operator.
Up to 32 one-byte alphanumeric characters (a to z, A to Z, 0 to 9) and symbols as shown below can be used.
(Alphabets are case sensitive.)

• ! " # $ % & ' ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~

9)8)7)6)5)4)3)2)1)

11)10) 12)
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• One-byte space (However, a one-byte space used at the end of the operator name is invalid.)
When you set a password in a CSV file, prepend the string "PASS:" to the password.
Otherwise, an error occurs when the CSV file is converted to an operator management information file 
(AUTHINF.G2U).
The password in the CSV file is visible.
Handle the CSV file with extreme caution accordingly.
To prevent the password in the CSV file from showing up, perform one of the following operations.

• Do not set any password in the CSV file. (Set passwords on the GOT.)
• Convert the CSV file into AUTHINF.G2U, and then convert AUTHINF.G2U back into the CSV file to encrypt the password in 

the file.
For the password encryption by the above method, refer to the following.

➟(14) Encrypting a password
6) [IS_PASSWD_EXP]

Set whether to set the password expiration date.
The following shows the setting range.

• [0]: Without expiration
• [1]: With expiration

7) [IS_EXT_AUTH]
Set whether to set the external authentication ID.
The following shows the setting range.

• [0]: Without setting
• [1]: With setting

8) [EXT_AUTH_ID]
Set the external authentication ID.
The number of bytes for the external authentication ID is the value set for [EXT_AUTH_ID_LEN] (number of bytes 
for the external authentication ID).
The setting method varies depending on the setting for [AUTH_TYPE].

• [ID_PASS]
The external authentication ID setting is not required.
When an operator management information file exported from the GOT is converted into a CSV file, the 
external authentication ID is displayed with ASCII characters. However, the ID is not recognized.

• [EXT_AUTH] and [EXT_AUTH+P]
Set the external authentication ID with hexadecimal numbers.
When editing a CSV file directly, add [BIN:] to the start of data.
Otherwise, an error occurs when the CSV file is converted to an operator management information file 
(AUTHINF.G2U).

9) [OPE_EXP]
Not used.
Leave the area blank.

10) [OPE_UNAVAILABLE_STATE]
Set whether to disable an operator account.
The following shows the setting range.

• [0]: Enables the operator account.
• [1]: Disables the operator account.

11) [PASSWD_CHANGE_FLG]
Set whether to display a message prompting for a password change at the next login.
The following shows the setting range.

• [0]: Does not display the message.
• [1]: Displays the message.

12) [IS_ADMIN_AUTH]
Set whether to grant administrator privileges to an operator.
The following shows the setting range.

• [0]: Not granted
• [1]: Granted

(11)Operator management information conversion log file (GTOperatorInfoConvResult.txt) configuration
The operator management information conversion log file is output when the conversion is executed with a command 
line.
The file is output to the folder where the conversion source file is stored.
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1) Conversion result code
The conversion result code is output in the following formats.

• 0: Normal end
• 1: Abnormal end

2) Conversion date
The conversion date is output in the following format.

• Year/Month/Day/Hour:Minute:Second
3) Executed command

The executed command is output.
4) Conversion result

The conversion result is output in the following formats.
• success: Normal end
• failure: Abnormal end

5) Message
The message at the conversion completion is output.

(12)Error log file (GTOperatorInfoConv.log) configuration
Checking the error location (line) in the CSV file and the error cause (error code) is available.
The file is output when a CSV file is converted into a G2U file only.
With no error, the file is not output.
The file is output to the folder where the conversion source file is stored.
If the folder already has a file with the same name, the file is overwritten.

1) Header part
The header part of the error file. (The character strings are fixed.)

2) Error code
The error line numbers and the error codes are displayed. (Line number: Error code)

➟(13) Error code list

(13)Error code list
The following shows the errors and the corrective actions corresponding to the error codes output to the error log file and 
others.

0
DayTime=2011/05/19/18:28:36
ExeCmd=C:\AUTHINF.CSV ***** /f /l 
Results=success
Cmnt=Conversion process is completed.

1)

5)
4)
3)
2)

[RESULT]
Line :ErrorCode
1:1001
12:1000

1)

2)

Error code Description Corrective action

1000
The configuration of the CSV file is invalid.
(An error other than the errors corresponding to error codes 
1001 to 1024)

Check if the specified CSV file is correct.

1001 The header data of the CSV file is invalid.
Check that the order of the keywords, the character strings, and 
the set values in the header part are correct. Correct them as 
necessary.

1010 The specified operator ID number is invalid.
Check that each operator ID number in the data part is within the 
setting range and does not contain invalid characters. Correct the 
operator ID number as necessary.

1011 The operator name is invalid.
Check that each operator name in the data part is within the 
setting range and does not contain invalid characters. Correct the 
operator name as necessary.

1012 The specified security level is invalid.
Check that each security level in the data part is within the setting 
range and does not contain invalid characters. Correct the 
security level as necessary.
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(14)Encrypting a password
When you edit a CSV file on a personal computer, encrypt the password ([PASSWD]) in the file by using the following 
procedure.

Step 1 In the header part of the CSV file, set [ENCRYPTED] for [PASS_TYPE].
Step 2 Convert the CSV file into an operator management information file by using GOT Operator Management 

Information Conversion Tool.
Step 3 Convert the operator management information file back into the CSV file.

The password is encrypted at the conversion.

■5 Precautions

(1) Precautions on drawing (operator authentication)
Set the security level of 0 for the screen displayed when logging out of the GOT.
When a security level (1 or more) is set for the screen displayed when logging out of the GOT, the screen for login is 
displayed after logging out of the GOT.

1013 The specified password is invalid.

Check that each password in the data part is within the setting 
range and does not contain invalid characters. For an encrypted 
password, check that all characters of the password can be 
represented in hexadecimal. Correct the password as necessary.

1014 The set value of the setting whether to set the password 
expiration date is invalid. Check that the set value is valid. Correct the value as necessary.

1015 The set value of the setting whether to set the external 
authentication ID is invalid. Check that the set value is valid. Correct the value as necessary.

1016 The specified external authentication ID number is invalid.

Check that each external authentication ID number is valid. 
Correct the ID number as necessary.
Check that the authentication type set in the header part requires 
the setting of external authentication ID numbers.

1017 The set value of the function setting is invalid.

The conversion source file contains setting items uneditable by 
the authenticated sub administrator.
Perform the file conversion with the administrator account or the 
sub administrator account in a security level that can edit all items 
in the conversion source file.

1018 The specified security level is invalid.

The specified security level is higher than that of the 
authenticated sub administrator.
Perform the file conversion with the administrator account or the 
sub administrator account in a security level that can edit all items 
in the conversion source file.

1019 The specified operator name has already existed. Register a different operator name.

1020 The specified operator ID number has already existed. Register a different operator ID number.

1021 The specified external authentication ID number has already 
existed. Register a different external authentication ID number.

1022 The number of operator accounts has exceeded the 
registration limit.

Delete some operator accounts to make the number of the 
accounts within the registration limit.
• For GT27, GT25, GT SoftGOT2000, and GS25: 1000 accounts 

or less
• For GT23, GT21, and GS21: 255 accounts or less

1023 The operator management information on the administrator is 
invalid.

For the operator management information on the administrator 
(operator name: Administrator), you can only change the 
password or disable the administrator account.
Set [-] for the other items.

1024 The specified item of the function setting is invalid.
Perform the file conversion with the administrator account or the 
sub administrator account in a security level that can edit all items 
in the conversion source file.

2000 The file format of AUTHINF.G2U is invalid. Check that the specified file (AUTHINF.G2U) is correct.

2001 The security level of the authenticated sub administrator is 
inappropriate.

Perform authentication with the administrator account or the sub 
administrator account in the same security level as 
[SUB_ADMIN_FORMAT] of a CSV file.

Error code Description Corrective action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Prohibiting sharing the external authentication ID
Do not use the external authentication ID among multiple operators.
When the external authentication ID is used among multiple operators, the authentication cannot be executed correctly 
because the operators cannot be specified by the external authentication ID.

(3) Password management
Delete the operator management information of the operator who has stopped using the GOT.
Leaving the operator management information increases the risk of invalid operations.
The administrator password cannot be checked later. Therefore, always make a note of the password. When the 
administrator password is forgotten, the operator management information cannot be registered, edited, and deleted.

(4) Solutions when forgetting the password or external authentication ID

(5) Corrective action when the login is blocked due to incorrect login attempts
If login attempts fail consecutively more than the specified number of times within five minutes, all operator accounts 
except the administrator one are locked until the login block time elapses.
To log in during the block time, perform one of the following operations.

• Log in with the administrator account, and unlock operator accounts in [Function setting] (Operator authentication).
• Restart the GOT.

For information on how to cancel the login block, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(6) Corrective action when an operator ID is locked due to incorrect login attempts
If an operator consecutively fails to log in more than the specified number of times, the operator ID is locked even after 
the login block time elapses.
Log in with the administrator account and unlock the target operator ID in the operator information edit screen.
For information on how to unlock an operator ID, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(7) Target of password requirements
When you set a password on the GOT, the password is checked for password requirements.
The passwords set before the requirements are specified, and the passwords set in the operator management 
information file (*.CSV) are not checked.

(8) Handling of the password in a CSV file
When you set a password ([PASSWD]) in a CSV file converted with GOT Operator Management Information Conversion 
Tool, the password in the CSV file is visible.
Handle the CSV file with extreme caution accordingly.
To prevent the password in the CSV file from showing up, perform one of the following operations.

• Do not set any password in the CSV file. (Set passwords on the GOT.)
• Convert the CSV file into AUTHINF.G2U, and then convert AUTHINF.G2U back into the CSV file to encrypt the 

password in the file.
For the password encryption by the above method, refer to the following.

➟5.2.7 ■4 (14) Encrypting a password

(9) How to input a value beginning with zeros
When editing a CSV file by using spreadsheet software, the leading zeros of a value beginning with zeros may be 
removed.
To input a value beginning with zeros, add @ to the beginning or end of the value.
@ is not recognized as a value during conversion.

Situation Solution

When forgetting the password of an operator Delete the operator information with the forgotten password, and register the operator 
information again.

When forgetting the external authentication ID Check the operator information on the operator information management screen, and 
then set the external authentication ID for the external authentication device again.

When forgetting the administrator password

Delete the operator management information file (AUTHINF.G2U) and register all 
operator management information again.
The operator management information file is deleted after the BootOS is installed.
For GT SoftGOT2000, use GT SoftGOT2000 of another module.
To use GT SoftGOT2000 with the forgotten password, install it again.
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(10)Automatic addition of @
When an operator management information file is converted into a CSV file, @ may automatically be added to the set 
values of some setting items to not to remove zeros by spreadsheet software.
When the CSV file is converted into an operator management information file, @ is not recognized as a value. Therefore, 
deleting @ is not required.

■6 Relevant settings

Set the relevant settings other than the specific settings for the security function as required.
The following shows the functions that are available by the relevant settings.

(1) Internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying that the authentication by the external authentication device succeeds. GS240.b0

Notifying that the authentication by the external authentication device fails. GS240.b1

Notifying that the login screen or operator re-authentication screen is being 
displayed regardless of authentication method. GS240.b13

Notifying that the login screen for the authentication by the external authentication 
device is displayed. GS240.b14

Notifying that the external authentication ID input key window is displayed. GS240.b15

Notifying the screen that cannot be displayed because of the insufficient security 
level. GS241.b1 to b4, b8 to b12 GS1241.b0 to b2, b8 to b10

Notifying that the login is blocked due to incorrect login attempts GS242.b0

Notifying that an operator ID is locked due to incorrect login attempts GS242.b1

Prohibiting deletion of the existing operator information GS621.b0

Prohibiting editing of the inactivated operator information GS621.b1

Inactivating the [Import] button on the [Operator management] screen of the utility. GS621.b2
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5.2.8 Configuring the security settings for the GOT screen ([Screen Security] (Level 
authentication))

■1 Specifications of the level authentication
The level authentication is performed using user-specified passwords corresponding to each security level.
Use the level authentication to configure a system which allows the operators in upper hierarchies to control all the 
operations which can be made by the operators in lower hierarchies.

■2 Settings for the level authentication
The following shows the procedure for configuring the level authentication settings.

Step 1 Configure the setting for the project with GT Designer3.
Display [Security] of the [Environmental Setting] window and configure the following settings in the [Screen 
Security] tab.

• [Authentication Method]
Select [Level].

• [Security Level Device]
Set any word device or bit device specified as a word device.

• [Security Level Password]
Set a password for each security level.
The password must be set for each security level.
(The password must not be overlapped.)

➟5.2.6 ■4 Level authentication
Step 2 Set the security level for each screen and objects on the screens.

➟2.7 Changing Screen Property
8. OBJECT FUNCTION

■3 How to switch the security level in the GOT
Two methods are available for switching the security level in the GOT as follows.

(1) Input the password for each security level in the [Security level authentication] dialog.
Display the [Security level authentication] dialog by touching the special function switch to which [Password (Security 
Level)] is set.
The [Security level authentication] dialog can also be displayed by displaying the utility and touching the [Security level 
authentication] button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

348B348B

Line No. 1
A 1254A 1254

555C555C

• Password for each security level
  Security level 10: Lion-010
                :
  Security level 5: Fox-005
                :
  Security level 3: Rabbit-003

Password: Fox-005

Password: Rabbit-003

Password: Lion-010

System administrators

Equipment administrators

Operators

Screen display with the 
security level 10

348B348B

Line No. 1
A 1254A 1254

555C555C

348B348B

Line No. 1
A 1254A 1254

555C555C

Screen display with the 
security level 5

Line No. 1

Screen display with the 
security level 3

Objects with the security 
level 10

Objects with the security 
level 5
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When the security level is inadequate for input, if you touch a special function switch for which [Switch Action] is set to 
the utility or any monitor function screen, the [Security level authentication] dialog appears.
(The touch switch does not function if its operating condition is unsatisfied.)

(2) Store the security level value to the security level device.
The security level device is a device to notify and change the current security level.
Store the value of the security level to this device, and the security level is switched accordingly.
For example, when the security level is [1], writing [10] to the security level device [D100] switches the security level to 
[10].

Place a word switch to which security levels are assigned on the screen, so that the user can switch between the security 
levels with a single touch on the switch.
For a user who switches the security level between the high security level for maintenance and inspection and security 
level for regular operation, the switch is useful when switching the security level to the level for regular operation.
The switch eliminates the need for distributing multiple passwords according to the operation level.

■4 Precautions
(1) Password management

The level authentication increases the risk of invalid operations because all operators can know the password for each 
security level.
When using the level authentication, manage the password strictly by changing the password frequently.
The registered password cannot be checked later. Therefore, always make a note of the password.
When the password is forgotten, security levels cannot be changed.

(2) Solutions when forgetting the password
Delete the password with GT Designer3 and set a new password.
After setting, write the project to the GOT again.

(3) Precautions when switching the security level temporarily to the higher level
When switching the security level temporarily to the higher level for maintenance and inspection or other operations, 
make sure to return the security level to the level for regular users after the operation.
Otherwise, an unauthorized user can perform operation that must not be performed by that user.

(4) When the value in the security level device changes
The processing, such as the following, performed at screen switching is also performed when the value in the security 
level device changes.
Initial operation of a project script, screen script, or script parts object

[Security level authentication] dialog

The display is changed according to the changed security level.

Sta.

Product 
qty

Line control

Sta.

Product qty

Line control

RUN

500

Current security 
level: 1

Current security 
level: 10

Security level 
device
D100: 1

↓
D100: 10
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5.2.9 Configuring the security settings for operations in the utility ([Functional 
Operation Security])

■1 Specifications of the functional operation security
The functional operation security restricts displaying the utility and parameter setting screens.

(1) Operations restricted by the functional operation security
The functional operation security restricts the following operations.

• Displaying the utility and operating some monitor functions
To restrict operations other than the above, use the following security functions.
Using multiple security functions in combination further strengthens the security.

(a) Function restricting project operations

(b) Function restricting communication with the GOT

(c) Function restricting the GOT operations

(2) Restricting starting up the utility

To start the utility, the security authentication is required.
Restricting the start of the utility avoids unnecessary operations to the utility.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Utility display Utility display

Inputting a password is requested.
Touch the touch switch of 
"Utility display".

Function Description

Security key authentication
Restricts a project to be viewed on GT Designer3 or executed on the GOT by protecting the project with 
a security key.
➟2.12 Protecting a Project with a Security Key

Project security
Restricts unregistered users to view or edit a project by registering users with the project. Also restricts 
operations by screen according to the access level of each user.
➟2.13 Protecting a Project by Registering Users

Function Description

Data transfer security
Restricts data transfer between the personal computer (GT Designer3) and the GOT with a password.
➟5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

IP filter
Restricts access to the GOT by Ethernet by registering IP addresses with the filtering list.
➟5.4.3 Setting the IP filter

Function Description

Screen security
Restricts the display of screens and objects on the GOT by registering users with the GOT.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Switching the screen to the utility Input a password. The utility appears when the input 
password is correct.

Exit
Exit
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(3) Restricting displaying the servo amplifier or motion parameters

To display the parameter setting screen with the servo amplifier monitor or the motion monitor, the password 
authentication is required.
Restricting the display avoids unwanted change of the parameter setting.

(4) Restricting displaying the ladder editor screen and the device test operation

The security authentication can restrict unnecessary ladder editor operations and device test operations.
Displaying the ladder editor screen and the device test operation can be restricted.
The ladder editor operations and device test operations can be restricted by the authentication with a device, 
authentication with a password, or authentication with a device and password combined.
Select the authentication type according to the purpose.

(a) Authentication with an authorization device
While an authorization device turns on, the operation is allowed.

(b) Authentication with a password
When the input password matches the set password, the operation is allowed.

(c) Authentication with an authorization device and password combined
When the input password matches the set password and an authorization device turns on, the operation is allowed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

ﾊｰﾄﾞｺﾋﾟｰ
中断

Switching the screen to the 
parameter setting screen

Input a password. The parameter setting screen appears 
when the input password is correct.

ﾊｰﾄﾞｺﾋﾟｰ
開始

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

A ladder editor screen appears 
when the authorization device is on.

Authorization device
M1000: ON

Calling a ladder editor screen 
from a ladder monitor screen

Calling a ladder editor screen 
from a ladder monitor screen

Input a password. A ladder editor screen appears 
when the input password is correct.
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■2 Settings for the functional operation security
The following shows the procedure for setting the functional operation security.

Step 1 Configure the setting in the project on GT Designer3.
Select [Common] → [GOT Environmental Setting] → [Security] from the menu to display the [Environmental 
Setting] window ([Security]).

Step 2 In the [Functional Operation Security] tab, set the password for a target item.

➟■4 [Security] ([Functional Operation Security] tab)

■3 Precautions
(1) Password management

The registered password cannot be checked later. Therefore, always make a note of the password.
When the password is forgotten, the following operations may be disabled.

• Displaying the utility
• Displaying the parameter setting screen of the servo amplifier and the motion controller
• Displaying the device test screen and the ladder editor screen

(2) Solutions when forgetting the password
Use [Utilize Project] to create a new project.
Deselect [GOT Environmental Setting/GOT Setup] from items to be utilized to initialize all the settings for the GOT 
environmental settings and the GOT setup.
At this time, the password is deleted.
After configuring the settings for the GOT environmental settings and the GOT setup, write the created project to the 
GOT.

Input a password. A ladder editor screen appears 
when the input password is correct 
and the authorization device is on.

Authorization device
M1000: ON

Calling a ladder editor screen 
from a ladder monitor screen
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■4 [Security] ([Functional Operation Security] tab)

1) [Utility Activation]
Set a password to restrict starting up the utility.

Item Description

Password When the password is set, [********] is displayed. Up to 32 characters are available.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

5)
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[Edit] button

Edit the password. When registering a new password, the [Password Setting] dialog 
appears.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When changing the password, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button

Displays the [Delete Password] dialog.

• [Password]
Set the password currently set for the project.

Item Description
5 - 136 5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

2) [Motion Parameter Display]
Not available to GT21, GT SoftGOT2000, and GS21.
Set the password to restrict displaying the parameters for the R motion monitor or Q motion monitor.

Item Description

Password When the password is set, [********] is displayed. Up to 32 characters are available.

[Edit] button

Edit the password. When registering a new password, the [Password Setting] dialog 
appears.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When changing the password, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button

Displays the [Delete Password] dialog.

• [Password]
Set the password currently set for the project.
5. COMMON SETTING
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3) [Servo Parameter Display]
Not available to GT21, GT SoftGOT2000, and GS21.
Set the password to restrict displaying the parameters for the servo amplifier monitor.

Item Description

Password When the password is set, [********] is displayed. Up to 32 characters are available.

[Edit] button

Edit the password. When registering a new password, the [Password Setting] dialog 
appears.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When changing the password, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button

Displays the [Delete Password] dialog.

• [Password]
Set the password currently set for the project.
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4) [Device Test Operation]
Not available to GT21, GT SoftGOT2000, and GS21.
Set a device and a password to restrict the device test operation.

Item Description

Authorization device

Set an authorization device for the device test. A bit device can be set for the authorization 
device.
• ON: Device test operation permitted
• OFF: Device test operation prohibited

Password When the password is set, [********] is displayed. Up to 32 characters are available.

[Edit] button

Edit the password. When registering a new password, the [Password Setting] dialog 
appears.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When changing the password, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button

Displays the [Delete Password] dialog.

• [Password]
Set the password currently set for the project.
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5) [Ladder Editor Screen Display]
Not available to GT21, GT SoftGOT2000, and GS21.
Set a device and a password to restrict displaying the ladder editor screen.

Item Description

Authorization device

Set the authorization device for the ladder editor screen display. A bit device can be set for 
the authorization device.
• ON: Display of ladder editor screen permitted
• OFF: Display of ladder editor screen prohibited

Password When the password is set, [********] is displayed. Up to 32 characters are available.

[Edit] button

Edit the password. When registering a new password, the [Password Setting] dialog 
appears.

• [Password]
Set a password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When changing the password, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button

Displays the [Delete Password] dialog.

• [Password]
Set the password currently set for the project.
5 - 140 5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

5.2.10 Configuring the security setting for transferring data ([Data Transfer Security])

■1 Specifications of the data transfer security
The data transfer security prevents unauthorized reading and writing of a project and resource data by password-based 
authentication.

For information on how to set the data transfer security, refer to the following.
➟■4 [Security] ([Data Transfer Security] tab)

(1) Operations restricted by the data transfer security
The data transfer security restricts the following operations.

• Transferring data between a personal computer (GT Designer3) and GOT
To restrict operations other than the above, use the following security functions.
Using multiple security functions in combination further strengthens the security.

(a) Function restricting project operations

(b) Function restricting communication with the GOT

(c) Function restricting the GOT operations

(2) Restricting reading the project and the resource data
After the data transfer security is set for the project, an authentication with a password is required for reading the project 
or the resource data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Project and resource data

Function Description

Security key authentication
Restricts a project to be viewed on GT Designer3 or executed on the GOT by protecting the project with 
a security key.
➟2.12 Protecting a Project with a Security Key

Project security
Restricts unregistered users to view or edit a project by registering users with the project. Also restricts 
operations by screen according to the access level of each user.
➟2.13 Protecting a Project by Registering Users

Function Description

IP filter
Restricts access to the GOT by Ethernet by registering IP addresses with the filtering list.
➟5.4.3 Setting the IP filter

Function Description

Screen security
Restricts the display of screens and objects on the GOT by registering users with the GOT.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Functional operation security
Restricts the display of the utility, and operations of some monitor functions.
➟5.2.9 Configuring the security settings for operations in the utility ([Functional Operation Security])

Reading the project 
and the resource data

Authentication with a password

GOT GT Designer3
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(3) Protecting the project written to the GOT
For the project which the data transfer security is set to, an authentication with a password is required for overwriting.

When all the following conditions are satisfied, inputting a password is not required because the authentication is 
performed automatically.

• The project IDs or package folder names match each other between the project contained in package data to be 
written and the existing project in the GOT.

• The set data transfer passwords match each other between the project contained in package data to be written and 
the existing project in the GOT.

• At the first writing of package data, [Retain the password while the GT Designer3 is open] was selected in the dialog 
for inputting the data transfer password.

You can check and change the project ID in the [Project Information] dialog.
➟2.3.5 Giving a title to a project

■2 Settings for the data transfer security
The following shows the procedure for setting the data transfer security.

Step 1 Configure the setting in the project on GT Designer3.
Select [Common] → [GOT Environmental Setting] → [Security] from the menu to display the [Environmental 
Setting] window ([Security]).

Step 2 In the [Data Transfer Security] tab, set the password.

➟■4 [Security] ([Data Transfer Security] tab)

■3 Precautions
(1) Password management

The registered password cannot be checked later. Therefore, always make a note of the password.
When the password is forgotten, the following operations may be disabled.

• Writing the package data to the GOT
• Reading the project and the resource data from the GOT

(2) Solutions when forgetting the password
Install the BootOS again.
Installing the BootOS again deletes all data in the GOT, such as the project and the resource data.

Writing 
the package data

Authentication with a password

GOT GT Designer3
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■4 [Security] ([Data Transfer Security] tab)

1) [Update Data Transfer Security]
Overwrites the data transfer security set with GT Designer3 to the GOT when the package data is written.
Select this item to set [Data Transfer] items.

2) [Data Transfer]
Set or delete the data transfer security.

Item Description

[Password] When the data transfer password is set, [********] is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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[Edit] button

Edit the data transfer password. When the data transfer password is not set, the [Password 
Setting] dialog appears.

• [Password]
Set a data transfer password.

• [Re-enter Password]
Input the password set in [Password] for the confirmation.

When the data transfer password is set, the [Editing password] dialog appears.

• [Old Password]
Set the password currently set for the project.

• [New Password]
Set a new data transfer password.

• [Re-enter Password]
Input the password set in [New Password] for the confirmation.

[Delete] button Deletes the set password.

Item Description
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5.2.11 Configuring the settings for creating the operation history of the GOT 
([Operation Log])

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

➟■1 Specifications of the operation log
■2 How to use the operation log
■3 Recording the operator name as the character string stored in the device
■4 Precautions
■5 [Operation Log...]
■6 [Operation Log File Conversion] dialog
■7 Relevant settings

The history of operations performed on the GOT can be saved to data storage.
Operation histories can be used to specify the cause of troubles occurring at the production site.
A saved history can be checked by the following methods.

• Using the GOT utility
• Using the resource file viewer of the personal computer
• Using the text editor or other tools of the personal computer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Production line
558
197

Line A
Line B

Target change
700
300

Line A
Line B

Date and time  Screen           Action           Before change      After change
      10:40               -       Screen switching              -               Base screen 10

Target change
600
300

Line A
Line B

Production line
563
199

Line A
Line B

Target change
700
300

Line A
Line B

Switch the screen to base screen 10.

Change the value using the numerical input.

Confirm the new value.

Switch the screen to base screen 20.

Date and time     Screen                   Action           Before change     After change
     10:40                 -                Screen switching              -               Base screen 10
     10:45     Base screen 10      Numerical input            600                     700
     10:50                 -                Screen switching              -               Base screen 20

Date and time     Screen                     Action            Before change     After change
       10:40                -                 Screen switching               -              Base screen 10
       10:45      Base screen 10    Numerical input              600                    700
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■1 Specifications of the operation log

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

(1) Target operations for recording operation logs

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
The operation logs of the following operations can be recorded.
There are items that need a setting on GT Designer3 to get their operation logs recorded and those that do not need any 
setting.
Some items are not recorded depending on the GOT model.
The operation logs of those that do not need any setting are always recorded while the logs are valid.
For the setting procedure, refer to the following.

➟5.2.11 ■5 (2) [Log Target] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GOT startup
When the GOT is powered on or restarted
➟(a) GOT startup

Not needed

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

GOT termination
When the GOT is terminated with a GOT special register (GS639.b14)

➟(b) GOT termination
12.1.3 ■5 (81) GOT Reset Control (GS639)

GOT restart

• When the GOT is restarted without reset (simple restart by changing the GOT 
basic settings in the utility) or with reset
(Simple restart does not occur in GT21 and GS21.)

• When the GOT is restarted with reset using a GOT special register 
(GS639.b15)

➟(c) GOT restart
12.1.3 ■5 (81) GOT Reset Control (GS639) (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

GOT offline mode 
transition

When transitioning to the offline mode (monitor stop mode) due to package data 
writing or while monitor screens are displayed
➟(d) GOT offline mode transition

GOT background 
processing stop, restart

When background processing of functions such as the backup/restore and 
logging functions stop or restart
➟(e) GOT background processing stop, restart

Log corruption 
information

When logs cannot be recorded in the file
➟(f) Log corruption information

Unknown logs
When unknown information is contained in collected operation logs
➟(g) Unknown logs

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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Application switching

• When monitor screens are displayed
• When utilities are launched
• When a screen is displayed from the utility
• When the setting screen for the operator authentication is displayed
• When various monitors such as the sequence program monitor are started
• When the backup/restore function is performed
• When package data are written to the GOT

➟(h) Application switching

[Application Switching]

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Application startup, exit

When the functions that use window screens, such as the remote personal 
computer operation (Ethernet) and the device monitor, are started or 
terminated.
➟(i) Application startup, exit

Time zone setting
When the GOT is started (only when the local time is used)
➟(j) Time zone setting (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Clock setting

• When the clock is set by time notifications from external devices
• When the clock is set in time synchronization with the SNTP server
• When the time is changed by using the GOT special register (GS)

➟(k) Clock setting, time change

[Time Change (Clock 
Setting and GS Change)] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Time change by using 
utilities

When the time is changed by using utilities
➟(l) Time change in the utility

[Time Change (Change 
from Utilities)] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

System language 
switching

• When the system language is changed by using utilities
• When the system language is changed by using the system language devices

➟(m) System language switching

[System Language 
Switching] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Displayed system 
language

When the system language is changed by using the system language devices
➟(n) Displayed system language

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GOT No. switching
When the GOT is switched
➟(o) GOT No. switching

[GOT No. Switching]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Screen switching
When screen switching is complete (base screen, overlap window, 
superimpose window, dialog window)
➟(p) Screen switching

[Screen Switching]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Station No. switching

When station No. switching is complete (common station number, base screen 
station number, overlap window station number, superimpose window station 
number, dialog window station number)
➟(q) Station No. Switching

[Station No. Switching]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Buffer memory unit No. 
switching

When the buffer memory unit No. switching is complete
➟(r) Buffer memory unit No. switching

[Buffer Memory Unit No. 
Switching] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Language switching
When language switching is complete
➟(s) Language switching

[Language Switching]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Object script

When object scripts are executed
➟(t) Object script
The logs are recorded only when all the following settings are made.
• [Operation Log Target] is valid in the object setting.
• The trigger type of an object script is set to [Key Code Input], [Input Fixation], 

or [Device Writing].

[Object Script]

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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Touch switch

When the following actions are executed by using touch switches
• Bit set
• Bit reset
• Bit momentary
• Bit alternate
• Storing values in word devices
• Activating various extended functions
• Screen switching
• Station No. switching
• Starting or exiting the auto repeat
• Switching to the screen gesture mode

➟(u) Touch switch
Because multiple actions can be set for a touch switch, the operation logs are 
recorded by action.

[Object]

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Numerical input

When the following operations are executed by using numerical inputs
• Storing input values in the target devices
• Storing input values in the target devices for writing
• Turning on the write completion devices

➟(v) Numerical input
The operation logs of numerical inputs are recorded in the operation log file 
every time the input values are written to devices.

Text input

When the following actions are executed by using text inputs
• Storing input values in the target devices
• Turning on the write completion devices

➟(w) Text input
The actions of text inputs are recorded in the operation log file every time the 
input data is written to devices.

Alarm operation (deletion)

When each (or all) alarm is deleted by using alarm displays (user) or alarm 
displays (system)
➟(x) Alarm display (alarm deletion)
This log is recorded only when each (or all) alarm that has been occurred is 
deleted. No operation log of the delete operations is recorded when the delete 
operations are performed in the situation that the alarms from which the system 
was recovered are selected, or no alarm is selected.

Device reset (user alarm, 
system alarm)

When device resetting is executed by using alarm displays (user) or alarm 
displays (system)
➟(y) Alarm display (device reset)
This log is recorded only when device resetting is executed only for alarms that 
have been occurred. No operation log of the delete operations is recorded when 
the delete operations are performed in the situation that the alarms from which 
the system was recovered are selected, or no alarm is selected. Reset 
operations at a higher level or middle level in the hierarchy also do not record 
operation logs.

Slider

When the following operations are executed by using sliders
• Touching the knob or the bar
• Releasing the finger from the knob or the bar

➟(z) Slider

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Recipe display (record 
list)

When the following operations are executed by using the recipe display (record 
list)
• Renaming a record
• Reading a record
• Writing a record
• Deleting a record

➟(aa) Recipe display (record list)

Level authentication 
(password entry)

When passwords are confirmed or otherwise by the level authentication
➟(ab) Level authentication (password entry)

[Password 
Authentication 
(Password Entry)] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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Level authentication (level 
device change)

When security levels are changed by using the security level devices
➟(ac) Level authentication (level device change)

[Password 
Authentication (Level 
Device Change)] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Operator authentication 
(login, login failure)

When operators succeed in logging in or fail to log in.
➟(ad) Operator authentication (login)

[Operator 
Authentication]

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Operator authentication 
(logout)

• When operators log out
• When operators are automatically logged out
• When operators are forcibly logged out

➟(ae) Operator authentication (logout)

Operator authentication 
(operator switching)

When operator switching is successful or results in failure
➟(af) Operator authentication (operator switching)

Operator authentication 
(password change)

When a password change succeeds or fails

➟(ag) Operator authentication (password change) (Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Operator authentication 
(operator account lock)

When an operator account becomes locked due to an operator authentication 
failure

➟(ah) Operator authentication (operator lock)

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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Operator management 
(start, end)

When the operator management screen or the function setting screen is 
displayed, fails to load, or is closed in the utility

➟(ai) Operator management (start, end)

[Operator Management]

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

Operator management 
(save, undo)

When the changes of the operator management information are saved or 
canceled

➟(aj) Operator authentication (save, undo)

Operator management 
(import, export)

When the operator management information file is imported or exported

➟(ak) Operator management (import, export)

Operator management 
(function settings)

When the function setting screen is closed in the utility
(The changed function settings are output only.)

➟(al) Operator management (function setting)

Operator management 
(operator management 
information)

When the operator management screen is closed in the utility
(The added, edited, or deleted operator information is output only.)

➟(am) Operator management (operator management information)

Operator management 
(new file creation at 
startup)

When the operator management information file cannot be read and a new file 
is created at GOT startup

➟(an) Operator management (new file creation at startup)

Operator management 
(file corruption at startup)

When the operator management information file fails to be read at GOT startup 
due to file corruption

➟(ao) Operator management (file corruption at startup)

Operator management 
(corrupted file restoration)

When a corrupted operator management information file is restored from the 
backup file

➟(ap) Operator management (corrupted file restoration at startup)

Operator management 
(abnormal end)

When the GOT is restarted after the GOT was accidentally powered off while 
displaying the operator management screen or the function setting screen in 
the utility

➟(aq) Operator management (illegal end)

Functional operation 
security

When succeeding in being confirmed by the functional operation security 
authentication or resulting in failure
➟(ar) Functional operation security authentication

[Functional Operation 
Security Authentication] (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

SoftGOT-GOT link (start, 
end)

When SoftGOT-GOT linking starts or ends
➟(as) SoftGOT-GOT link (start, end)

[SoftGOT-GOT Link]
SoftGOT-GOT 
(authorization transfer)

Via a SoftGOT-GOT link, when the authorization is transferred
➟(at) SoftGOT-GOT (authorization transfer)

VNC server (connection, 
disconnection)

When connected to/disconnected from the VNC server (GOT)
➟(au) VNC server (connection, disconnection)

[VNC Server]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

VNC server (authorization 
transfer)

When the VNC server (GOT) obtains or releases the authorization
➟(av) VNC server (authorization transfer)

GOT network interaction 
function (master GOT)

When the authorization of the GOT network interaction function is transferred 
(Logging on the master GOT)
➟(aw) GOT network interaction function (master GOT) [GOT Network 

Interaction]
GOT network interaction 
function (equipment 
except the master GOT)

When the authorization of the GOT network interaction function is transferred 
(Logging on the equipment except the master GOT)
➟(ax) GOT network interaction function (equipment except the master GOT)

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
5 - 152 5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

(2) Output items of operation logs

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
The following lists the items to be output into the operation log files.
For the timing of each log being recorded, refer to the following.

➟5.2.11 ■1 (1) Target operations for recording operation logs

(a) GOT startup

*1 When no battery has been installed in the GOT, the clock is initialized on startup. Hence the date and time in 
initial state are recorded.
When time synchronization is performed after the initialization, operation logs that were collected before the 
synchronization may be lost.
If the startup time needs correct recording, install a battery in the GOT.

(b) GOT termination

GOT Mobile function 
(successful 
authentication)

When the client becomes authenticated to the server (GOT)
➟(ay) GOT Mobile function (successful authentication)

[GOT Mobile]

GOT Mobile function 
(authentication failed)

When the client fails to be authenticated to the server (GOT)
➟(az) GOT Mobile function (authentication failed)

GOT Mobile function 
(disconnection)

When the client becomes disconnected from the server (GOT)
➟(ba) GOT Mobile function (disconnection)

GOT Mobile function 
(GOT Mobile device 
assignment)

When the client becomes authenticated to the server (GOT)
➟(bb) GOT Mobile function (GOT Mobile device assignment)
The operation events are recorded for VGB and VGD respectively.

Screen gesture
When the screen gesture mode and the normal operation mode is switched
➟(bc) Screen gesture

Not needed

File print (start)
When printing a file starts

➟(be) File print (start)
[File Print]

File print (end)
When printing a file ends

➟(bf) File print (end)

Network drive 
(connection)

When the network drive is connected

➟(bd) Network drive (connection)
[Network Drive]

Item Timing of operation log being recorded Setting on GT Designer3 Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT being started or restarted. *1

ACT_ABBR Function 
abbreviation Records [Start].

ACTION Function name Records [Start GOT].

OPNAME Operation name Records the projects' names.

USER_ID User ID Records the project ID numbers of initiated project data.

CHG_VALUE Change value Records the GOT model numbers. Example) Model No.1: GOT_No-1

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT being terminated.

ACT_ABBR Function 
abbreviation Records [End].

ACTION Function name Records [Terminate GOT].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(c) GOT restart

(d) GOT offline mode transition

(e) GOT background processing stop, restart

(f) Log corruption information

(g) Unknown logs

(h) Application switching

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT being restarted.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When simply restarted: [ReStart]
• When restarted by resets: [ReStartR]

ACTION Function name
Records events as shown below.
• When simply restarted: [Simple restart of GOT]
• When restarted by resets: [Reset & Restart GOT]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT transitioning to the offline mode.

ACT_ABBR Function 
abbreviation Records [Offline].

ACTION Function name Records [Shift to GOT offline mode].

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of background processing stopping or restarting.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When background processing stops: [BGStop]
• When background processing restarts: [BGRStart]

ACTION Function name
Records events as shown below.
• When background processing stops: [Stop GOT background process]
• When background processing restarts: [Resume GOT background process]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT abandoning operation logs.

ACT_ABBR Function 
abbreviation Records [LostLog].

ACTION Function name Records [LostLog].

CHG_VALUE Change value Records the number of the logs that were abandoned.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of unknown operation logs being collected.

ACT_ABBR Function 
abbreviation Records [Unknown].

ACTION Function name Records [Unknown].

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of applications being switched.

ACT_ABBR Function 
abbreviation Records [AppChng].

ACTION Function name Records [Switch applications].
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*1 If [Unknown] is displayed, update the BootOS to the latest version.
The BootOS version may be earlier than that of the GOT which created the operation log file.

(i) Application startup, exit

CHG_VALUE Change value

Records events as shown below.
• When monitor screens are displayed: [Monitor]
• When utilities are launched: [Utility]
• When the device monitor is started: [Device monitor]
• When the sequence program monitor (iQ-R/iQ-L ladder) is started: [Sequence Program 

Monitor(iQ-R/iQ-L Ladder)]
• When the sequence program monitor (iQ-F ladder) is started: [Sequence Program 

Monitor(iQ-F Ladder)]
• When the sequence monitor is started: [Seq program monitor]
• When the FX list editor is launched: [List editor for FX]
• When the FX list monitor is started: [Ladder monitor for FX]
• When the intelligent module monitor is started:

[Intelligent unit monitor]
• When the network monitor is started: [Network monitor]
• When the Q motion monitor is started: [Q motion monitor]
• When the R motion monitor is started: [R motion monitor]
• When the servo amplifier monitor is started: [Servo amp monitor]
• When the CNC monitor is started: [CNC monitor]
• When the CNC data I/O is started: [CNC data I/O function]
• When the CNC machining program is edited: [CNC program editor]
• When the multimedia screen is activated: [Multimedia screen]
• When the setting screen for the backup/restore function is displayed: [Backup/restoration]
• When the setting screen for the operator authentication is displayed: [Operator 

authentication]
• When the list screen for the operator management information is displayed: [Operator 

information mng. (List)]
• When the log viewer is launched: [Log viewer]
• When the Q motion SFC monitor is started: [Q motion SFC monitor]
• When the motion program editor is started: [Motion program editor]
• When the motion program I/O is started: [Motion program I/O]
• When the iQSS utility is started: [iQSS utility]
• When the system launcher is started: [System launcher]
• When the CNC monitor 2 is started: [CNC monitor 2]
• When the file manager is started: [File management]
• When the drive recorder is started: [Drive recorder]
• When the CC-Link IE TSN/CC-Link IE Field Network diagnostics is started: [CC-Link IE 

TSN/CC-Link IE Field Network diagnostics]
• When the servo amplifier graph function is started: [Servo amplifier graph]
• When the file print function is started: [File print]
• When the personal computer screen on the GOT is displayed in the full screen mode:

[PC Remote Operation (Ethernet)]
• When the R motion SFC monitor is started: [R motion SFC monitor]
• When the vision sensor monitor is started: [Vision sensor monitor]
• When unknown applications are launched: [Unknown]*1

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of applications being launched or exited.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When applications are launched: [AppStart]
• When applications are exited: [AppEnd]

ACTION Function name
Records events as shown below.
• When applications are launched: [Start application]
• When applications are exited: [End application]

Output item Name Description
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(j) Time zone setting

(k) Clock setting, time change

(l) Time change in the utility

CHG_VALUE Change value

Records the names of the applications that are launched or exited.
• When the personal computer screen on the GOT is displayed in the window display 

mode:
[PC Remote Operation (Ethernet)]

• When the device monitor is used: [Device monitor]
• When the recipe operation is used: [Recipe operation]
• When the drive recorder is used: [Drive recorder]
• When the document display (search and bookmark functions for PDF files) is used: [PDF 

search, bookmark function]
• When the servo amplifier graph is used: [Servo amplifier graph]
• When the network drive setting is used: [Network drive setting]
• When unknown applications are used: [Unknown]

PREV_VALUE Previous value
Records the window screens that applications use.
• Overlap window 1 to 5: [OVA1] to [OVA5]
• Superimpose window 1 to 2: [SPI1] to [SPI2]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the time zone being changed.

ACT_ABBR Function 
abbreviation Records [TimeZone].

ACTION Function name Records [Set time zone].

CHG_VALUE Change value
Records the time zone setting. The following takes the time zone (Japan) of Greenwich 
Mean Time + 9 hours as an example.
• [GMT+9:00]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time When the clock is changed, records the dates and time of the clock being changed using 
the previous clock.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When notified from external devices: [GetTime]
• When synchronized with SNTP: [GetTimeS]
• When changed by using the GOT special register (GS): [SetTime]

ACTION Function name

Records events as shown below.
• When notified from external devices: [Adjust (External device)]
• When synchronized with SNTP: [Set time (SNTP)]
• When changed by using the GOT special register (GS): [Adjust (GS)]

CHG_VALUE Change value When the time is changed, records the new time.

PREV_VALUE Previous value When the time is changed, records the previous time.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time When the clock is changed, records the dates and time of the clock being changed using 
the previous clock.

ACT_ABBR Function 
abbreviation Records [ChngTime].

ACTION Function name Records [Change clock].

OPERATOR Operator name
When operator authentication is performed, records the name of the operator who has 
been logging in. If operations are performed by VNC clients, the logs are prefixed with 
asterisk (*).

OPE_ID Operator ID When operator authentication is performed, records the ID No. of the operator who has 
been logging in.

CHG_VALUE Change value When the time is changed, records the new time.

PREV_VALUE Previous value When the time is changed, records the previous time.

Output item Name Description
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(m) System language switching

*1 If the system language switching devices have been enabled, system language switching by using utilities is 
disabled.

In this case, if you try to change the system language with utilities, the corresponding operation log is output; 
however, the system languages are not switched.
You can check if the system languages have been switched by checking the operation log of [Display system 
language] that is output after system language switching.

(n) Displayed system language

(o) GOT No. switching

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the system language being changed by using utilities.* 1

ACT_ABBR Function 
abbreviation Records [SysLang].

ACTION Function name Records [Switch system languages].

OPERATOR Operator name
When operator authentication is performed, records the name of the operator who has 
been logging in. If operations are performed by VNC clients, the logs are prefixed with 
asterisk (*).

OPE_ID Operator ID When operator authentication is performed, records the ID No. of the operator who has 
been logging in.

CHG_VALUE Change value When the system language is changed, records the new system language.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of system language switching being performed.

ACT_ABBR Function 
abbreviation Records [DspSysLg].

ACTION Function name Records [Display system language].

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

CHG_VALUE Change value When the system language is changed, records the new system language.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of GOT No. switching being performed.

ACT_ABBR Function 
abbreviation Records [ChgGOTNo].
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(p) Screen switching

ACTION Function name Records [Display system language].

OPERATOR Operator name
When operator authentication is performed, records the name of the operator who has 
been logging in. If operations are performed by VNC clients, the logs are prefixed with 
asterisk (*).

OPE_ID Operator ID When operator authentication is performed, records the ID No. of the operator who has 
been logging in.

CHG_VALUE Change value When the GOT model No. is changed, records the new No. Example) Model No.1: 
GOT_No-1

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of screen switching being performed.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When base screens are switched: [BASE]
• When overlap windows 1 to 5 are switched: [OVL1] to [OVL5]
• When superimpose windows 1 to 2 are switched: [SPI1] to [SPI2]
• When dialog windows are switched: [DLG]
• When the key windows that a user created are switched: [KEY]

ACTION Function name

Records events as shown below.
• When base screens are switched: [Screen switching: Base]
• When overlap windows 1 to 5 are switched:

[Screen switching: Overlap 1] to [Station No. switching: Overlap 5]
• When superimpose windows 1 to 2 are switched:

[Screen switching: Superimpose 1] to [Screen switching: Superimpose 2]
• When dialog windows are switched: [Screen switching: Dialog]
• When the key windows that a user created are switched: [Screen switching: Key]

OPNAME Operation name Records the titles of the screens that appear after screen switching.

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

CHG_VALUE Change value Records the numbers of the screens that appear after screen switching. Example) Screen 
No.100 (base screen): [BASE_100]

Output item Name Description
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(q) Station No. Switching

(r) Buffer memory unit No. switching

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of station No. switching being performed.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the common station numbers are switched: [CmnST]
• When base screen station numbers are switched: [BaseST]
• When the station numbers of overlap windows 1 to 5 are switched: [Ovl1ST] to [Ovl5ST]
• When the station numbers of superimpose windows 1 to 2 are switched:

[Spi1ST] to [Spi2ST]
• When the station numbers of dialog windows are switched: [DlgST]

ACTION Function name

Records events as shown below.
• When the common station numbers are switched: [Station No. switching: Common]
• When base screen station numbers are switched: [Station No. switching: base]
• When the station numbers of overlap windows 1 to 5 are switched:

[Station No. switching: Overlap 1] to [Station No. switching: Overlap 5]
• When the station numbers of superimpose windows 1 to 2 are switched:

[Station No. switching: Superimpose 1] to [Station No. switching: Superimpose 2]
• When the station numbers of dialog windows are switched: [Station No. switching: Dialog]

CHG_VALUE Change value
When station numbers are changed, records the new numbers in the following form.
• ST_network No.-PC station No.
Example) Network No.1, PC station number 2: [ST_1-2]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time of the buffer memory unit No. switching.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the common buffer memory unit number is switched in the project: [CmnBM]
• When the buffer memory unit number is switched in a base screen: [BaseBM]
• When the buffer memory unit number is switched in overlap windows 1 to 5:

[Ovl1BM] to [Ovl5BM]
• When the buffer memory unit number is switched in superimpose windows 1 to 2:

[Spi1BM] to [Spi2BM]
• When the buffer memory unit number is switched in a dialog window: [DlgBM]

ACTION Function name

Records events as shown below.
• When the common buffer memory unit number is switched in the project: [BM unit switching: 

Common]
• When the buffer memory unit number is switched in a base screen:

[BM unit switching: Base]
• When the buffer memory unit number is switched in overlap windows 1 to 5:

[BM unit switching: Overlap 1] to [BM unit switching: Overlap 5]
• When the buffer memory unit number is switched in superimpose windows 1 to 2:

[BM unit switching: Superimpose 1] to [BM unit switching: Superimpose 2]
• When the buffer memory unit number is switched in a dialog window:

[BM unit switching: Dialog]

CHG_VALUE Change value Records the destination module number specified after the buffer memory unit No. switching. 
Example) Module No. 10: [U10]
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(s) Language switching

(t) Object script

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of language switching being performed.

ACT_ABBR Function 
abbreviation Records [DispLang].

ACTION Function name Records [Switch languages].

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

CHG_VALUE Change value When the comment column numbers are changed, records the new numbers.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of object scripts being initiated.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the objects have been placed. The 
following takes screen No.10 as an example of a display.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation Records [ObScr].

ACTION Function name Records [Object Script].

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

OPERATOR Operator name
When operator authentication is performed, records the name of the operator who has 
been logging in. If operations are performed by VNC clients, the logs are prefixed with 
asterisk (*).

OPE_ID Operator ID When operator authentication is performed, records the ID No. of the operator who has 
been logging in.

USER_ID User ID Records the ID numbers of the objects for which the object scripts have been set.

DATA_TYPE Data type Records the data types of the trigger devices.
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*1 If internal devices are used as the target devices for writing operation results, the results are not output to the 
operation log file.

When needing the logs of the operation results, use devices of external devices as the target devices.

(u) Touch switch
Because multiple actions can be set for a touch switch, the operation logs are recorded by action.

CH_NUM Channel No. Records the channel number that is specified for the trigger device.

NET_STA Network No., station 
No., and CPU No.

Records the network number, station number, and CPU number that are specified for the 
trigger device.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3

DEV_NAME Device name Records the names of the trigger devices.

CHG_VALUE Change value Records the operation results of the object scripts. *1

CHG_VALUE_CONT Change value 
(operation) Records the values input into the objects by operators.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of touch switches being operated.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the touch switches have been 
placed. The following takes screen No.10 as an example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records the following logs for each action that has been set for the touch switches.
• Bit set: [TSW_SET]
• Bit reset: [TSW_RST]
• Bit alternate: [TSW_ALT]
• Bit momentary: [TSW_MMT]
• Word set: [TSW_DAT]
• Special function: [TSW_APP]
• Special function (Recipe data operation)

When importing a file: [TSW_RCIN]
When exporting a file: [TSW_RCEX]

• Screen Switching: [TSW_SCRN]
• Station No. switching: [TSW_ST]
• Screen gesture: [TSR_GES]
If the auto repeat has been set for the touch switches, the following logs are recorded.
• When the auto repeat starts: [TSW_REPB]
• When the auto repeat ends: [TSW_REPE]

ACTION Function name

Records the following logs for each action that has been set for the touch switches.
• Bit set: [Touch switch: Bit SET]
• Bit reset: [Touch switch: Bit RST]
• Bit alternate: [Touch switch: Bit ALT]
• Bit momentary: [Touch switch: Bit Momentary]
• Word set: [Touch switch: Word write]
• Extended functions: [Touch switch: Application switching]
• Special function (Recipe data operation)

When importing a file: [Touch switch: Recipe operation import]
When exporting a file: [Touch switch: Recipe operation export]

• Screen switching: [Touch switch: Screen switching]
• Station No. switching: [Touch switch: Station No. switching]
• Screen gesture: [Touch switch: Screen gesture]
If the auto repeat has been set for the touch switches, the following logs are recorded.
• When the auto repeat starts: [Touch switch: Start auto repeat]
• When the auto repeat ends: [Touch switch: End auto repeat]

Output item Name Description
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OPNAME Operation name

Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab
The text displayed on a touch switch immediately before the first operation of the switch is 
recorded regardless of the settings of [Operation Timing] and [Press Twice].
If text is set for each display position (up, down, right, left, or center), only the centered text 
will be recorded.
When [Text Type] is set to [Text], text is recorded under the following constraints.
• The characters completely extending off the object area are not recorded.
• Multiple-line text is recorded by merging the lines into one.

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

USER_ID User ID Records the user ID numbers of the touch switches. If no user ID number has been set, [-
] is recorded.

SUB_NO Action No. When multiple actions are set for a touch switch, the order of the actions is recorded.

DATA_TYPE Data type

Records the data types of the devices that have been set for the touch switches.
• Bit: [BIT]
• Signed 8-bit binary data: [BIN8]
• Unsigned 8-bit binary data: [BIN8_Unsigned]
• Signed 16-bit binary data: [BIN16]
• Unsigned 16-bit binary data: [BIN16_Unsigned]
• Signed 32-bit binary data: [BIN32]
• Unsigned 32-bit binary data: [BIN32_Unsigned]
• Signed 64-bit binary data: [BIN64]
• Unsigned 64-bit binary data: [BIN64_Unsigned]
• BCD16: [BCD16]
• BCD32: [BCD32]
• BCD64: [BCD64]
• Real numbers (32 bits): [REAL]
• Real numbers (64 bits): [REAL64]

CH_NUM Channel No. Records the channel number that is specified for the device of a touch switch.

NET_STA Network No., station 
No., and CPU No.

Records the network number, station number, and CPU number that are specified for the 
device of a touch switch.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3

DEV_NAME Device name Records the devices that have been set for the touch switches.

Output item Name Description
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(v) Numerical input
The operation logs of numerical inputs are recorded in the operation log file every time the input values are written to 
devices.

CHG_VALUE Change value

Records the following logs for each action that has been set for the touch switches.
• [Bit Set], [Bit Reset], [Bit Momentary], [Bit Alternate], [Word Set]:

As a result of the actions, the values stored in the devices are output.
• [Screen Switching]: Records the screen numbers of the screens that appear after screen 

switching.
• [Station No. Switching]: When station numbers are switched, records the type of the 

switching and the new station number. Example) In common station No. switching, when 
switching to network No.1 and PC station No.2.: [CmnST_1-2]

• [SP Function] ([Recipe Data Operation]): Records the recipe number of the import 
destination or export source.

If the auto repeat has been set for the touch switches, the following logs are recorded.
• When the auto repeat ends: The number of the repeats

CHG_VALUE_CONT Change value 
(operation)

Records the values input by touch switches.
When [Switch Action] is set to [Recipe Data Operation], the full path to the import source 
file or export destination file is recorded.

PREV_VALUE Previous value
When device values are changed, records the previous device values. To log the values, 
select [Collect previous device values at the time of touch switch operation] in the [Log 
Target] tab in [Operation Log] of the [Environmental Setting] window.

PREV_VALUE_DISP Previous value 
(display)

When device values are changed, records the previous device values that have been 
displayed on the objects. To log the values, select [Collect previous device values at the 
time of touch switch operation] in the [Log Target] tab in [Operation Log] of the 
[Environmental Setting] window.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of numerical inputs being operated.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the numerical inputs have been 
placed. The following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records the following logs of each target device for writing.
• Monitor devices: [NUM_VAL]
• Write devices: [NUM_WDEV]
• Write completion devices: [NUM_WCHK]

ACTION Function name

Records the following logs of each target device for writing.
• Monitor devices: [Numerical Input]
• Write devices: [Numerical Input (Write device)]
• Write completion devices: [Numerical Input (Write check)]

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

Output item Name Description
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OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

USER_ID User ID
Records the user ID numbers of the numerical inputs.
If no user ID number has been set, [-] is recorded.

SUB_NO Action No.

Records the number corresponding to an action.
• Writing data to the monitor device: [1]
• Writing data to the write device: [2]
• Turning on the write completion device: [3]

DATA_TYPE Data type

Records the data types of the devices that have been set for the numerical inputs.
• Bit: [BIT]
• Signed 8-bit binary data: [BIN8]
• Unsigned 8-bit binary data: [BIN8_Unsigned]
• Signed 16-bit binary data: [BIN16]
• Unsigned 16-bit binary data: [BIN16_Unsigned]
• Signed 32-bit binary data: [BIN32]
• Unsigned 32-bit binary data: [BIN32_Unsigned]
• Signed 64-bit binary data: [BIN64]
• Unsigned 64-bit binary data: [BIN64_Unsigned]
• BCD16: [BCD16]
• BCD32: [BCD32]
• BCD64: [BCD64]
• Real numbers (32 bits): [REAL]
• Real numbers (64 bits): [REAL64]

CH_NUM Channel No. Records the channel number that is specified for the device of a numerical input.

NET_STA Network No., station 
No., and CPU No.

Records the network number, station number, and CPU number that are specified for the 
device of a numerical input.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3

DEV_NAME Device name
Records the names of the target devices for writing from the numerical inputs.
If the offset function has been set, records device numbers to which offset device values 
were added.

CHG_VALUE Change value
When device values are changed, records the new device values.
The execution results of data operations and scripts are also reflected to the device values.

CHG_VALUE_CONT Change value 
(operation) Records the values input into numerical inputs.

Output item Name Description
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*1 While a key code is being entered, the corresponding device value is not reflected to the display on the 
numerical input object until the entry is confirmed.

If the device value is changed before the entry is confirmed, inconsistencies occur in the data of PREV_VALUE 
and PREV_VALUE_DISP.

(w) Text input

PREV_VALUE Previous value*1 When device values are changed, records the previous device values.

PREV_VALUE_DISP Previous value 
(display)*1

Records the previous device value that is displayed on the numerical input object before a 
key code is entered.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of text inputs being operated.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the text inputs have been placed. 
The following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records the function abbreviation corresponding to an action.
• Writing data to the monitor device: [STR_VAL]
• Turning on the write completion device: [STR_WCHK]

ACTION Function name
Records the function name corresponding to an action.
• Writing data to the monitor device: [Input text]
• Turning on the write completion device: [Input text (Write check)]

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

Output item Name Description
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*1 When the previous values are displayed, the new text codes are used.
If the text codes are changed after the values are changed, the previous values may not be displayed normally.

(x) Alarm display (alarm deletion)

USER_ID User ID Records the user ID numbers of the text inputs. If no user ID number has been set, [-] is 
recorded.

SUB_NO Action No.
Records the number corresponding to an action.
• Writing data to the monitor device: [1]
• Turning on the write completion device: [2]

DATA_TYPE Data type

Records the character code of the monitor device to which data is written.
• Alphanumeric characters (ASCII): [ASCII]
• Alphanumeric characters (Unicode): [Unicode]
• Japanese (SJIS): [SJIS]
• Chinese (Simplified) (GB): [GB]
• Korean (KS): [KS]
• Chinese (Traditional) (Big5): [Big5]
Records the data type of the write completion device that is on.
• Bit: [BIT]

CH_NUM Channel No. Records the channel number that is specified for the device of a text input.

NET_STA Network No., station 
No., and CPU No.

Records the network number, station number, and CPU number that are specified for the 
device of a text input.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3

DEV_NAME Device name Records the names of the target devices for writing from the text inputs.

CHG_VALUE Change value
Records the new device value when data is written to the monitor device.
The execution results of scripts are also reflected to the device values.
Records [1] when the write completion device is on.

CHG_VALUE_CONT Change value 
(operation)

Records the input data of the text input when data is written to the monitor device.
Records [1] when the write completion device is on.

PREV_VALUE Previous value Records the previous device value when data is written to the monitor device.*1

Records nothing when the write completion device is on.

PREV_VALUE_DISP Previous value 
(display)

Records the previous device value displayed on the text input when data is written to the 
monitor device.
Records nothing when the write completion device is on.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of alarm data being deleted.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the alarm displays have been 
placed. The following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When user alarms are deleted: [UALM_DEL]
• When system alarms are deleted: [SALM_DEL]
• When all user alarms are deleted: [UALM_DEA]
• When all system alarms are deleted: [SALM_DEA]

ACTION Function name

Records events as shown below.
• When user alarms are deleted: [User alarm: Delete]
• When system alarms are deleted: [System alarm: Delete]
• When all user alarms are deleted: [User alarm: Delete all]
• When all system alarms are deleted: [System alarm: Delete all]

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

Output item Name Description
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(y) Alarm display (device reset)

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

USER_ID User ID Records the user ID numbers of the alarm displays. If no user ID number has been set, [-
] is recorded.

SUB_NO Alarm ID Records the alarm ID numbers of the user alarms. For system alarms, [-] is recorded.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of devices being reset using alarm displays.

SCRN_NO Screen No.

Records the screen numbers of the screens on which the alarm displays have been 
placed. The following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When user alarms are used: [UALM_RST]
• When system alarm are used: [SALM_RST]

ACTION Function name
Records events as shown below.
• When user alarms are used: [User alarm: Reset]
• When system alarms are used: [System alarm: Reset]

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

Output item Name Description
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OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

USER_ID User ID Records the user ID numbers of the alarm displays. If no user ID number has been set, [-
] is recorded.

SUB_NO Alarm ID Records the alarm ID numbers of the user alarms. For system alarms, [-] is recorded.

DATA_TYPE Data type
For user alarms, [BIT] is recorded. (data types of the devices that are reset)
For system alarms, nothing is recorded.

CH_NUM Channel No. For user alarms, the channel number specified for the reset device is recorded.

NET_STA Network No., station 
No., and CPU No.

For user alarms, the network number, station number, and CPU number that are specified 
for the reset device are recorded.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3
For system alarms, nothing is recorded.

DEV_NAME Device name
For user alarms, records the names of the devices that are reset.
For system alarms, nothing is recorded.

CHG_VALUE Change value
For user alarms, when device values are changed, records the new device values.
For system alarms, nothing is recorded.

PREV_VALUE Previous value
For user alarms, when device values are changed, records the previous device values.
For system alarms, nothing is recorded.

Output item Name Description
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(z) Slider

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the slider being operated.

SCRN_NO Screen No.

Records the screen number of the screen on which the slider has been arranged. The 
following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Key windows: [KEY_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation Records [SLR_OPE].

ACTION Function name Records [Slider Control].

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

OPERATOR Operator name
When operator authentication is performed, records the name of the operator who has 
been logging in. If operations are performed by VNC clients, the logs are prefixed with 
asterisk (*).

OPE_ID Operator ID When operator authentication is performed, records the ID No. of the operator who has 
been logging in.

USER_ID User ID Records the user ID of the slider. If no user ID number has been set, [-] is recorded.

DATA_TYPE Data type

Records the data type of the device that has been set for the slider.
• Bit: [BIT]
• Signed 8-bit binary data: [BIN8]
• Unsigned 8-bit binary data: [BIN8_Unsigned]
• Signed 16-bit binary data: [BIN16]
• Unsigned 16-bit binary data: [BIN16_Unsigned]
• Signed 32-bit binary data: [BIN32]
• Unsigned 32-bit binary data: [BIN32_Unsigned]
• Signed 64-bit binary data: [BIN64]
• Unsigned 64-bit binary data: [BIN64_Unsigned]
• BCD16: [BCD16]
• BCD32: [BCD32]
• BCD64: [BCD64]
• Real numbers (32 bits): [REAL]
• Real numbers (64 bits): [REAL64]

CH_NUM Channel No. Records the channel number that is specified for the device of the slider.

NET_STA Network No., station 
No., and CPU No.

Records the network number, station number, and CPU number that are specified for the 
device of the slider.
Example) When network No. 2, station No. 1, and CPU No. 3 are specified: '2-1/3

DEV_NAME Device name
Records the name of the device where data is written from the slider. For system alarms, 
nothing is recorded. If the offset function has been set, records device numbers to which 
offset device values were added.

CHG_VALUE Change value When device values are changed, records the new device values. The execution results of 
data operations and scripts are also reflected to the device values.

CHG_VALUE_CONT Change value 
(operation) Records the position of the knob.

PREV_VALUE Previous value When device values are changed, records the previous device values.

PREV_VALUE_DISP Previous value 
(display) Records the previous position of the knob when the position of the knob is changed.
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(aa) Recipe display (record list)

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which a record is manipulated by using the recipe display 
(record list).

SCRN_NO Screen No.

Records the screen number of the screen on which the recipe display (record list) has been 
placed. The following takes screen No.10 as a record example of each screen.
• Base screens: [BASE_10]
• Overlap windows 1 to 5: [OVL1_10] to [OVL5_10]
• Superimpose windows 1 to 2: [SPI1_10] to [SPI2_10]
• Dialog windows: [DLG_10]
• Base screens (GOT Mobile): [MBL-BASE_10]
• Overlap windows 1 to 2 (GOT Mobile): [MBL-OVL1_10] to [MBLOVL2_10]
• Superimpose windows 1 to 2 (GOT Mobile): [MBL-SPI1_10] to [MBLSPI2_10]

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When renaming a record: [RVW_RN]
• When reading a record: [RVW_RD]
• When writing a record: [RVW_WT]
• When deleting a record: [RVW_DEL]

ACTION Function name

Records events as shown below.
• When renaming a record: [Recipe (record list): Change record name]
• When reading a record: [Recipe (record list): Read]
• When writing a record: [Recipe (record list): Write]
• When deleting a record: [Recipe (record list): Delete record]

OPNAME Operation name
Records the object operation name specified on the [Log Target] tab of [Operation Log] in 
the [Environmental Setting] dialog.

➟5.2.11 ■5 (2) [Log Target] tab

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

USER_ID User ID Records the user ID for the recipe display (record list). If no user ID number has been set, 
[-] is recorded.

SUB_NO Recipe No. Records the recipe number for the records displayed on the recipe display (record list).

CHG_VALUE Change value Records the record number targeted for manipulation.

CHG_VALUE_CONT Change value 
(operation)

Records the record name targeted for manipulation. When the record is renamed, a new 
record name is recorded.

PREV_VALUE_DISP Previous value 
(display)

Records the old record name when the record is renamed. When any other manipulation 
is performed, [-] is recorded.
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(ab) Level authentication (password entry)

(ac) Level authentication (level device change)

(ad) Operator authentication (login)

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of passwords being entered for level authentication.

ACT_ABBR Function 
abbreviation Records [ScrtPwd].

ACTION Function name Records [Change security levels(password)].

OPERATOR Operator name

Records events as shown below.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID Records the security levels at the time of password inputs.

CHG_VALUE Change value When security levels are changed, records the new security levels.

PREV_VALUE Previous value
Records the result of authentication.
• If confirmed: [OK]
• If not confirmed: [NG]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time When level authentication is performed, records the dates and time of levels being 
changed by using the security level devices.

ACT_ABBR Function 
abbreviation Records [ScrtLv].

ACTION Function name Records [Change levels (device)].

OPERATOR Operator name

Records events as shown below.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

CHG_VALUE Change value When security levels are changed, records the new security levels.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of attempts to log in being made.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When succeeding in logging in: [Login]
• When failing to log in: [LoginNG]

ACTION Function name
Records events as shown below.
• When succeeding in logging in: [Login]
• When failing to log in: [Login failed]
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(ae) Operator authentication (logout)

(af) Operator authentication (operator switching)

OPERATOR Operator name

Records events as shown below.
• When performing operations on the GOT: Operator name entered at login
• When performing operations on the VNC client: *(Operator name entered at login)[(VNC 

client IP address)]
Example) *user1[192.168.3.20]

• When performing operations on the GOT Mobile function client: *(Operator name entered 
at login)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]

When login attempts fail, the following is recorded.
• When inputting an incorrect operator name: Operator name specified at authentication 

(blank when no operator name is specified)
• When inputting an incorrect password: Operator name specified at authentication
• When failing to log in with the external authentication or GOT Mobile function: [-]

OPE_ID Operator ID When logging in is successful, records the ID numbers of the confirmed operators. When 
logging in results in failure, [0] is recorded.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of operations logging out.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When operators log out: [Logout]
• When operators are automatically logged out: [ALogout]
• When operators are forcibly logged out: [CLogout]

ACTION Function name

Records events as shown below.
• When operators log out: [Logout]
• When operators are automatically logged out: [Automatic logout]
• When operators are forcibly logged out: [Forced logout]

OPERATOR Operator name

Records events as shown below.
• When performing operations on the GOT: Logged-out operator name
• When performing operations on the VNC client: *(Logged-out operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]

• When performing operations on the GOT Mobile function client: *(Logged-out operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]

OPE_ID Operator ID Records the ID numbers of the operators who logged out.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of attempts to switch operators being made.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When operator switching is successful: [ChgOp]
• When operator switching results in failure: [ChgOpNG]

ACTION Function name
Records events as shown below.
• When operator switching is successful: [Switch operator]
• When operator switching results in failure: [Operator switching failed]

OPERATOR Operator name

Records events as shown below.
• When performing operations on the GOT: Operator name after operator switching
• When performing operations on the VNC client: *(Operator name after operator 

switching)[(VNC client IP address)]
Example) *user1[192.168.3.20]

• When performing operations on the GOT Mobile function client: *(Operator name after 
operator switching)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]

OPE_ID Operator ID When operators are changed, records the ID numbers of the new operators.

Output item Name Description
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(ag) Operator authentication (password change)

(ah) Operator authentication (operator lock)

(ai) Operator management (start, end)

(aj) Operator authentication (save, undo)

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which a password change succeeded or failed.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When a password change succeeds: [ChPass]
• When a password change fails: [ChPassNG]

ACTION Function name
Records events as shown below.
• When a password change succeeds: [Password change]
• When a password change fails: [Password change (failure)]

OPERATOR Operator name Records the name of the operator who has changed the password.

OPE_ID Operator ID Records the ID No. of the operator who has changed the password.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which an operator account was locked due to an 
authentication failure.

ACT_ABBR Function 
abbreviation Records [OpLock].

ACTION Function name Records [Operator lock].

OPERATOR Operator name Records the name of the locked-out operator.

OPE_ID Operator ID Records the ID number of the locked-out operator.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time

Records the date and time of the following events.
• When the operator management screen or the function setting screen is displayed in the 

utility
• When the operator management screen or the function setting screen fails to load in the 

utility
• When the operator management screen or the function setting screen is closed in the 

utility

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the screen is displayed: [OpMStart]
• When the screen fails to load: [OpMNG]
• When the screen is closed: [OpMEnd]

ACTION Function name

Records events as shown below.
• When the screen is displayed: [Operator management: start]
• When the screen fails to load: [Operator management: start failure]
• When the screen is closed: [Operator management: end]

OPERATOR Operator name Records the operator name of the administrator or sub administrator who has been 
authenticated by the administrator password authentication.

OPE_ID Operator ID Records the operator ID number of the administrator or sub administrator who has been 
authenticated by the administrator password authentication.

CHG_VALUE Change value
Records events as shown below.
• When the operator management screen is displayed: [Operator management]
• When the function setting screen is displayed: [Function setting]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time
Records the following dates and time.
• When the changes of the operator management information are saved
• When the changes of the operator management information are canceled
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(ak) Operator management (import, export)

(al) Operator management (function setting)

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the changes of the operator management information are saved: [OpMSave]
• When the changes of the operator management information are canceled: [OpMUndo]

ACTION Function name

Records events as shown below.
• When the changes of the operator management information are saved: [Operator 

management: save]
• When the changes of the operator management information are canceled: [Operator 

management: undo]

OPERATOR Operator name Records the operator name of the administrator or sub-administrator who has been 
authenticated by the administrator password authentication.

OPE_ID Operator ID Records the operator ID of the administrator or sub-administrator who has authenticated 
the administrator password.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which the operator management information file was 
imported or exported.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When importing a file: [OpMImp]
• When exporting a file: [OpMExp]

ACTION Function name
Records events as shown below.
• When importing a file: [Operator management: import]
• When exporting a file: [Operator management: export]

OPERATOR Operator name Records the operator name of the administrator or sub-administrator who has 
authenticated the administrator password.

OPE_ID Operator ID Records the operator ID of the administrator or sub-administrator who has authenticated 
the administrator password.

CHG_VALUE Change value Records the full path to the import source file or export destination file.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which the function setting screen was closed in the utility.

ACT_ABBR Function 
abbreviation

Records the changed function settings.
• Authentication type: [OpMAuthM]
• Automatic logout time: [OpMALOut]
• Password expiration date: [OpMPassE]
• External authentication ID: [OpMEAuID]
• Login block: [OpMAuthP]
• Operator account lock: [OpMLock]
• Password requirements: [OpMPassR]
• Password history: [OpMPassH]
• Use of sub administrators: [OpMSuAdm]

ACTION Function name

Records the items changed in the function setting.
• Authentication type: [Operator management: auth. method]
• Automatic logout time: [Operator management: automatic logout]
• Password expiration date: [Operator management: pwd. exp. date]
• External authentication ID: [Operator management: ext. auth. ID]
• Login block: [Operator management: auth. prohibited]
• Operator account lock: [Operator management: operator lock]
• Password requirements: [Operator management: pwd requirements]
• Password history: [Operator management: password history]
• Sub administrator: [Operator management: sub admin.]

OPERATOR Operator name Records the operator name of the administrator or sub-administrator who has 
authenticated the administrator password.

OPE_ID Operator ID Records the operator ID of the administrator or sub-administrator who has authenticated 
the administrator password.

Output item Name Description
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(am) Operator management (operator management information)

CHG_VALUE Change value

Records the changes that have been made to the function settings.
If multiple entries are present in a sub field, the entries are separated by a slash mark (/).
"n" represents a number.
• Authentication type

Authentication with an external authentication device: [External auth (serial)]
Authentication with an external authentication device and auxiliary authentication: [Ext. 
auth. (serial)/Op. name + pwd.]
Authentication with an external authentication device: [External auth (USB)]
Authentication with an external authentication device and auxiliary authentication: [Ext. 
auth. (USB)/Op. name + pwd.]

• Automatic logout time
Automatic logout time: [n min]

• Password expiration date
Expiration date: [Expiration: n days]
Prenotification: [Notification: n days]

• External authentication ID
Starting position: [Initial: n bytes]
Valid data length: [Data length: n bytes]

• Login block setting
Number of failed login attempts: [Continuous failure count: n]
Login block time: [Prohibition: n s]

• Operator account lock
Number of consecutive failed login attempts to lock an account: [Continuous failure 
count: n]

• Password requirements
Password requirement setting: [Enabled] or [Disabled]
Minimum number of characters in password: [Minimum: n characters]
Password character type: [Type: <No check>], [Type: <[A-Z,a-z]/[0-9,Other]>], [Type: 
<[A-Z,a-z]/0-9/Other>], or [Type: <A-Z/a-z/0-9/Other>]

• Password history
Number of passwords saved: [History count: n]
Deleting the history when importing the operator management information file: [Deletion 
on import: enabled], [Deletion on import: disabled]

• Sub-administrator: [Operator management: sub admin.]
Use of sub administrators: [Enabled] or [Disabled]
Showing of uneditable operator information: [Uneditable display: enabled] or [Uneditable 
display: disabled]
Security level to change the function setting: [Level n or higher]

PREV_VALUE Previous value
Records the entries that have been made before the function setting changes.
The sub fields are the same as for [CHG_VALUE] (Change value).

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which the operator management screen was closed in the 
utility.

ACT_ABBR Function 
abbreviation

Records the changes of the operator management information.
• When a piece of operator information is added: [OpMAddOp]
• When a piece of operator information is deleted: [OpMDelOp]
• When a piece of operator information is edited: [OpMEdiOp]

ACTION Function name

Records the changes of the operator management information.
• When a piece of operator information is added: [Operator management: add operator]
• When a piece of operator information is deleted: [Operator management: add operator]
• When a piece of operator information is edited: [Operator management: delete operator]

OPERATOR Operator name Records the operator name of the administrator or sub-administrator who has 
authenticated the administrator password.

OPE_ID Operator ID Records the operator ID of the administrator or sub-administrator who has authenticated 
the administrator password.

DEV_NAME Device name Records the operator name and ID number of a piece of operator information that has been 
added, deleted, or edited.

Output item Name Description
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(an) Operator management (new file creation at startup)

(ao) Operator management (file corruption at startup)

(ap) Operator management (corrupted file restoration at startup)

CHG_VALUE Change value

When a piece of operator information is added, the new entries are recorded in the 
following sub fields.
When a piece of operator information is deleted, the entries before the deletion are 
recorded in the following sub fields.
When a piece of operator information is edited, the entries after editing are recorded in the 
following sub fields.
The entries are separated by a slash mark (/) in each sub field.
n indicates a numerical value.
• Security level

Security level set for an operator: [Level: n]
• Password

When the password is changed: [Password change]
• Administrator authority

When the administrator authority is enabled: [Administrator authority: enabled]
When the administrator authority is disabled: [Administrator authority: disabled]

• Password expiration date setting
When no expiration date is set: [Permanent password: enabled]
When an expiration date is set: [Permanent password: disabled]

• Disabling an operator account
When the operator account is disabled: [Disable operators: enabled]
When the operator account is enabled: [Disable operators: disabled]

• Changing a password at the next login
When the password change setting is enabled: [Change password next login: enabled]
When the password change setting is disabled: [Change password next login: disabled]

• External authentication
When the external authentication is enabled: [External authentication: enabled]
When the external authentication is disabled: [External authentication: disabled]
When the external authentication ID number is changed: [Change external 
authentication ID]

• Operator lock
When the operator account is locked: [Locked]
When the operator account is unlocked: [Unlock]

PREV_VALUE Previous value

Records the entries only if any operator information has been edited.
Records the entries that have been made before the operator management information 
edit.
Items to be recorded are the same as [CHG_VALUE] (change value).

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which an operator management information file was created.

ACT_ABBR Function 
abbreviation Records [OpMNewOp].

ACTION Function name Records [Operator management: new].

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which an operator management information file failed to be 
read due to file corruption.

ACT_ABBR Function 
abbreviation Records [OpMInfBr].

ACTION Function name Records [Operator management: corrupted].

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the date and time on which an operator management information file was 
restored.

ACT_ABBR Function 
abbreviation Records [OpMRstor].

ACTION Function name Records [Operator management: restore].

OPERATOR Operator name Records the operator name of the administrator or sub administrator who has restored the 
corrupted file.

Output item Name Description
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(aq) Operator management (illegal end)

(ar) Functional operation security authentication

(as) SoftGOT-GOT link (start, end)

OPE_ID Operator ID Records the operator ID number of the administrator or sub administrator who has restored 
the corrupted file.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time
Records the date and time on which the GOT was restarted after the GOT was accidentally 
powered off while displaying the operator management screen or the function setting 
screen in the utility.

ACT_ABBR Function 
abbreviation Records [OpMUnEnd].

ACTION Function name Records [Operator management: illegal end].

OPERATOR Operator name Records the operator name of the administrator or sub administrator who was logged in 
when the GOT was accidentally powered off.

OPE_ID Operator ID Records the operator ID number of the administrator or sub administrator who was logged 
in when the GOT was accidentally powered off.

CHG_VALUE Change value Records the date and time on which the administrator or sub administrator logged into 
before the GOT was accidentally powered off.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time When function operating security authentication is performed, records the dates and time 
of attempts to be confirmed being made.

ACT_ABBR Function 
abbreviation Records [AppOpe].

ACTION Function name Records [Functional Operation Security Authentication].

CHG_VALUE Change value

Records the names of the functions that are confirmed by authentication.
• When utilities are launched: [Utility (start)]
• When the device monitor is started: [Device monitor (start)]
• When device tests of the sequence program monitor (SFC) are started:

[Seq program monitor_SFC (device test)]
• When device tests of the sequence program monitor (ladder) are started:

[Seq program monitor_ladder (dev.test)]
• When the editor screen for the sequence program monitor (ladder) is displayed:

[Seq program monitor_ladder (edit)]
• When device tests of the sequence program monitor (iQ-R/iQ-L ladder) are started:

[iQ-R/iQ-L Seq program monitor_ladder (test)]
• When the editor screen for the sequence program monitor (iQ-R/iQ-L ladder) is displayed:

[iQ-R/iQ-L Seq program monitor_ladder (edit)]
• When device tests of the sequence program monitor (iQ-F ladder) are started:

 [iQ-F Seq program monitor_ladder (test)] 
• When the editor screen for the sequence program monitor (iQ-F ladder) is displayed: 

[iQ-F Seq program monitor_ladder (edit)] 
• When the parameter setting screen for the Q motion monitor is displayed:

[Q motion monitor (parameter setting)]
• When the parameter setting screen for the servo amplifier monitor is displayed:

[Servo amp monitor (parameter setting)]

PREV_VALUE Authentication result
Records the result of authentication.
• If confirmed: [OK]
• If not confirmed: [NG]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of SoftGOT-GOT linking starting or ending.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When starting: [SLCnctG]
• When ending: [SLDCnctG]
The SoftGOT records the following logs.
• When starting: [SLCnctS]
• When ending: [SLDCnctS]

Output item Name Description
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(at) SoftGOT-GOT (authorization transfer)

(au) VNC server (connection, disconnection)

(av) VNC server (authorization transfer)

(aw) GOT network interaction function (master GOT)

ACTION Function name
Records events as shown below.
• When starting: [Connect Soft GOT-GOT link]
• When ending: [Disconnect Soft GOT-GOT link]

CHG_VALUE Change value Records the IP addresses of connection request sources.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the authorization being transferred via a SoftGOT-GOT link.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• In the GOT: [SLChCtlG]
• In the SoftGOT: [SLChCtlS]

ACTION Function name Records [Shift Soft GOT-GOT link authorization].

CHG_VALUE Change value
Records the destinations to which the authorization is transferred. When the destination is 
the SoftGOT, the IP address is also recorded. Example) When transferred from the GOT 
to the SoftGOT: [SoftGOT:192.168.3.40]

PREV_VALUE Previous value
Records the transfer sources of the authorization. When the source is the SoftGOT, the IP 
address is also recorded. Example) When transferred from the GOT to the SoftGOT: 
[GOT]

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the establishment of the connection to the VNC server or 
the disconnection from the server.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When connected: [VSCnct]
• When disconnected: [VSDCnct]

ACTION Function name
Records events as shown below.
• When connected: [Connect VNC server]
• When disconnected: [Disconnect VNC server]

CHG_VALUE Change value Records the IP addresses of connection request sources.

Output item Name Description

[No.] Log number Records a log number.

DATE Date and time Records the dates and time of the GOT obtaining or releasing the authorization.

ACT_ABBR Function 
abbreviation Records [VSChCtlC].

ACTION Function name Records [Shift VNC server authorization].

CHG_VALUE Change value
Records the destinations to which the authorization is transferred. When the destination is 
a VNC client, the IP address is also recorded. Example) When transferred from the VNC 
server to a VNC client: [Client:192.168.3.39]

PREV_VALUE Previous value
Records the transfer sources of the authorization. When the source is a VNC client, the IP 
address is also recorded. Example) When transferred from the VNC server to a VNC client: 
[Server]

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the authorization is transferred.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When any equipment in the control group obtains the authorization: [MngCtrlGet]
• When the authorized equipment releases the authorization: [MngCtrlRls]

ACTION Function name

Records events as shown below.
• When any equipment in the control group obtains the authorization: [Obtain operating 

authority]
• When the authorized equipment releases the authorization: [Release operating authority]

Output item Name Description
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(ax) GOT network interaction function (equipment except the master GOT)

CHG_VALUE Change value

Records information on the equipment that obtained or released the authorization.
• For the GOT: IP address
• For the VNC client: VNC:(IP address)
• For the GOT Mobile function client: M(Client No.):(IP address)
• For GT SoftGOT2000: SG(Module No.):(IP address)

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the authorization is transferred.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the equipment obtains the authorization: [UsrCtrlGet]
• When the equipment releases the authorization: [UsrCtrlRls]
• When the equipment fails to obtain the authorization: [UsrCtrlFail]

ACTION Function name

Records events as shown below.
• When the equipment obtains the authorization: [Obtain operating authority use]
• When the equipment releases the authorization: [Release operating authority use]
• When the equipment fails to obtain the authorization: [Failed to obtain operating authority]

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *[M(Client No.):(Client IP 
address)]
Example) *[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT or VNC client: Security level
• When performing operations on the GOT Mobile function client: [-]

To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT or VNC client: Operator ID

If no operator is logged in, the operator ID number is 0.
• When performing operations on the GOT Mobile function client: [-]

To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

CHG_VALUE Change value Records the IP address of the master GOT.

Output item Name Description
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(ay) GOT Mobile function (successful authentication)

(az) GOT Mobile function (authentication failed)

(ba) GOT Mobile function (disconnection)

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the client became authenticated to the server (GOT).

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the connection becomes established: [MBLCnct]
• When the trial connection becomes established: [MBLTrialCnct]

ACTION Function name
Records events as shown below.
• When the connection becomes established: [GOT Mobile connection]
• When the trial connection becomes established: [GOT Mobile trial connection]

OPERATOR Operator name Records events as shown below.*(Operator name)[M(Client No.):(Client IP address)] 
Example) *user1[M3:192.168.3.20]

OPE_ID Operator ID
Records events as shown below.
• When [GOT Mobile Authentication Method] is set to [GOT Mobile exclusive]: 0
• When [GOT Mobile Authentication Method] is set to [Operator]: Operator ID

CHG_VALUE Change value Records information obtained from the User-agent header of the HTTP request (such as 
the browser name of the client).

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the client failed to be authenticated to the server 
(GOT).

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When authentication fails: [MBLAuthNG]
• When authentication fails because the number of connected clients has exceeded the 

upper limit: [MBLOver]

ACTION Function name

Records events as shown below.
• When the connection authentication fails: [GOT Mobile authentication failure]
• When authentication fails because the number of connected clients has exceeded the 

upper limit: [GOT Mobile connection limit over]

OPERATOR Operator name Records events as shown below.*(Operator name entered at authentication)[M-:(Client IP 
address)] Example) *user1[M-:192.168.3.20]

OPE_ID Operator ID Always records [0].

CHG_VALUE Change value Records information obtained from the User-agent header of the HTTP request (such as 
the browser name of the client).

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the client became disconnected from the server 
(GOT).

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the connection becomes disconnected: [MBLDCnct]
• When the connection is forcibly disconnected using the client control device or the utility: 

[MBLCDCnct]
• When the trial connection ends: [MBLTrialDCnct]
• When the connection is disconnected due to a communication error: [MBLTimeOut]

ACTION Function name

Records events as shown below.
• When the connection becomes disconnected: [GOT Mobile disconnection]
• When the connection is forcibly disconnected using the client control device or the utility: 

[GOT Mobile forced disconnection]
• When the trial connection ends: [GOT Mobile end of trial]
• When the connection is disconnected due to a communication error: [GOT Mobile 

timeout]

OPERATOR Operator name Records events as shown below.*[M(Client No.):Client IP address] Example) 
*[M3:192.168.3.20]
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(bb) GOT Mobile function (GOT Mobile device assignment)

(bc) Screen gesture

(bd) Network drive (connection)

(be) File print (start)
When multiple files are printed, operations are recorded for each file.

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which the client became authenticated to the server (GOT).

ACT_ABBR Function 
abbreviation Records [MBLVtlDev].

ACTION Function name Records [GOT Mobile virtual device allocation].

OPERATOR Operator name Records events as shown below.*[M(Client No.):Client IP address] Example) 
*[M3:192.168.3.20]

DATA_TYPE Data type

Records the device type of the GOT internal devices that are assigned to the GOT Mobile 
devices.
• Bit: [BIT]
• Signed 16-bit binary data: [BIN16]
• Unsigned 16-bit binary data: [BIN16_Unsigned]
• Signed 32-bit binary data: [BIN32]
• Unsigned 32-bit binary data: [BIN32_Unsigned]
• BCD16: [BCD16]
• BCD32: [BCD32]
• Real numbers (32 bits): [REAL]

DEV_NAME Device name Records the start device of the GOT internal devices that are assigned to the GOT Mobile 
devices.

CHG_VALUE Change value Records the number of the GOT internal devices that are assigned to the GOT Mobile 
devices.

PREV_VALUE Previous value Records the start device of the GOT Mobile devices.

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the dates and time when the gesture mode is switched.

ACT_ABBR Function 
abbreviation Records [ChScrGes].

ACTION Function name Records [Switch screen gesture].

CHG_VALUE Change value Records the changed gesture mode. Example) When transferred from the normal mode to 
the screen gesture mode: [Screen gesture mode]

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which connecting the network drive has succeeded or failed.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When the connection has succeeded: [VlmCnct]
• When the connection has failed: [VlmCnctNG]

ACTION Function name
Records events as shown below.
• When the connection has succeeded: [Connect network drive]
• When the connection has failed: [Network drive connection failed]

CHG_VALUE Change value
Records events as shown below.
(Drive name):(User name)
Example) N:user

PREV_VALUE Previous value Records events as shown below.
\\(IP address of the file server)\(Share name)\(Folder path)
Example) \\192.168.3.44\share\mount\doc

Output item Name Description

NO Log number Records a log number.

DATE Date and time
Records the printing date and time.
If multiple files are printed, the same date and time is recorded for each file.
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(bf) File print (end)
When multiple files are printed, operations are recorded for each file.

ACT_ABBR Function 
abbreviation Records [PntStart].

ACTION Function name Records [File print: start printing].

OPERATOR Operator name

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

CHG_VALUE Change value Records the name of the first printed file.

Output item Name Description

NO Log number Records a log number.

DATE Date and time Records the date and time on which printing ends.

ACT_ABBR Function 
abbreviation

Records events as shown below.
• When printing is complete: [PntEnd]
• When printing is aborted by the user: [PntUStop]
• When printing is aborted due to an access error: [PntCStop]
• When printing is aborted due to a printer error: [PntPStop]
• When printing is aborted due to a timeout error: [PntTStop]
• When printing is aborted by the system: [PntSStop]

ACTION Function name

Records events as shown below.
• When printing is complete: [File print: normal end]
• When printing is aborted by the user: [File print: cancelled (user)]
• When printing is aborted due to an access error: [File print: cancelled (access error)]
• When printing is aborted due to a printer error: [File print: cancelled (printer error)]
• When printing is aborted due to a timeout error: [File print: cancelled (timeout error)]
• When printing is aborted by the system: [File print: cancelled (system)]

Output item Name Description
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(3) Specifications of the operations log file

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Operation logs are saved in operation log files.
Up to 65500 logs can be recorded in a single operation log file.
When the number of logs exceeds 65500, another operation log file is newly created.

Data storage is needed to save operation logs.

OPERATOR Operator name

Records events only when printing is aborted by the user.
The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
When [None] or [Level] is selected for [Authentication Method], the following contents are 
recorded.
For [None], the security level is 0.
• When performing operations on the GOT: Level(Security level number)

Example) Level5
• When performing operations on the VNC client: *Level(Security level number)[(VNC 

client IP address)]
Example) *Level5[192.168.3.20]

• When performing operations on the GOT Mobile function client: *Level(Security level 
number)[M(Client No.):(Client IP address)]
Example) *Level5[M3:192.168.3.21]
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

When [Operator] is selected for [Authentication Method], the following contents are 
recorded.
• When performing operations on the GOT: Operator name

If no operator is logged in, the operator name is left blank.
• When performing operations on the VNC client: *(Logged-in operator name)[(VNC client 

IP address)]
Example) *user1[192.168.3.20]
The operator name is not recorded when the operator is not logged in.

• When performing operations on the GOT Mobile function client: *(Logged-in operator 
name)[M(Client No.):(Client IP address)]
Example) *user1[M3:192.168.3.21]
The operator name is not recorded when the operator is not logged in.
To record operations performed on the client, select [Collect operation logs of clients 
being connected to the server of GOT Mobile function] on the [Log Target] tab in 
[Operation Log] of the [Environmental Setting] window.

OPE_ID Operator ID

Records events only when printing is aborted by the user.
The contents to be recorded vary depending on the item selected for [Authentication 
Method] on the [Screen Security] tab in [Security] of the [Environmental Setting] window.
Records the security level when [None] or [Level] is selected for [Authentication Method].
For [None], the security level is 0.
Records the operator ID number when [Operator] is selected for [Authentication Method].
If no operator is logged in, the operator ID number is 0.

CHG_VALUE Change value Records the name of the last printed file.

Output item Name Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

558
197

700
197

OPELOG_20130401_0000.G2O

65500 logs

OPELOG_20130401_0000.G2O

65500 logs

OPELOG_20130401_0001.G2O

1 log

Production line
Line A
Line B

Target change
Line A
Line B
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(4) Operation log file name
The file name extension of operation log files is [.G2O].
A file name is any character string set by a user, followed by the automatically added log collection start date 
(YYYYMMDD) for the file and the version.

The version starts from 0000, and is incremented by one every time a new file is created.
After the number reaches 9999, it returns to 0000 in the name of the next new file.
For the character type and the number of characters available for file names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
For how to set file names, refer to the following.

➟5.2.11 ■5 (1) [Basic] tab

(5) Drives for saving operation log files
Drive A, B, E, F, G, or X (current drive) can be selected to save operation log files.
For how to set the destination for saving, refer to the following.

➟5.2.11 ■5 (1) [Basic] tab

(6) Time intervals at which operation logs are saved
You can select the time intervals, in days or weeks, at which operation logs are saved.
Saved operations log files are stored for a certain period of time and then deleted automatically.

• Saving in days (every day)

• Saving in weeks (every week)

(7) Size setting of operation log files to be saved
The total size of all operation log files that can be saved in data storage can be specified.
When the size exceeds the specified one, the oldest operation log file is automatically deleted.

OPELOG_20130401_0000.G2O

Any character string set by a user

Log collection start date

Version

Extension

OPELOG_
20130401_
0000.G2O

OPELOG_
20130402_
0001.G2O

OPELOG_
20130403_
0002.G2O

OPELOG_
20130407_
0006.G2O

Monday, April 1, 
2013

Tuesday, April 2, 
2013

Wednesday, April 3, 
2013

Sunday, April 7, 
2013

OPELOG_
20130401_
0000.G2O

OPELOG_
20130408_
0001.G2O

OPELOG_
20130415_
0002.G2O

OPELOG_
20130513_
0006.G2O

Monday, April 1, 
2013

Monday, April 8, 
2013

Monday, April 15, 
2013

Monday, May 13, 
2013
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(8) Specifications for recording labels and tags

When operations are logged, label and tag names are also recorded.
The following shows the labels and tags to be recorded.

• Global label
• OMRON NJ/NX tag
• AB native tag

Even if you change the label or tag set for an object or others, you can check the label or tag name as of the recording.
Note that the size of the log file becomes large if the recorded label or tag name is long.
When the station No. switching function, the offset function, or other functions are used, the label or tag name recorded 
in the operation log contains the relevant information.
Example) When the global label name is LABEL_B, the station number is 2-3, and the offset device value is 500
The global label name is recorded as [2-3::LABEL_B(+500)].

■2 How to use the operation log

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

(1) Checking operation logs
Operation logs can be checked by the following three methods.

(2) Operating operation log files
(a) Operating with utilities

The following operations of utilities are available.

For the operations of the utility, refer to the following manual.
➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Method Details

Using the GOT utility Operation logs can be checked and the files can be managed by the [Operation Log Information] utility.
For the operations of the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

Using the resource file viewer of the 
personal computer

Operation logs can be checked by using the resource file viewer of the personal computer.
The operation log file (*.G2O) obtained from the GOT or the converted operation log file (CSV or Unicode 
text file) is checked.
For the resource file viewer, refer to the following.

➟11.16 Viewing an operation log file (Resource File Viewer)
For how to convert the operation log file (*.G2O), refer to the following.

➟(3) CSV file conversion or Unicode text file conversion of operation log file

Using the text editor or other tools of 
the personal computer

Operation logs can be checked by using the text editor or other tools of the personal computer.
To enable this, convert the operation log file into a CSV or Unicode text file.

Item Description

Creates a folder Creates a folder where operation log files are stored. Folders are created by date or time period 
and operation log files are so managed.

Deletes a folder Deletes a folder that stores operation log files.

Copies a file Copies an operation log file. Perform this operation to back up an operation log file.

Deletes a file Deletes an operation log file.

Changes a file name Renames an operation log file.

Moves a file Moves an operation log file to another folder. Perform this operation to back up an operation log 
file.

Converses a file (G2O) into a CSV file or a 
Unicode text file Converts an operation log file (*.G2O) to Unicode or CSV.

Search Searches for an operation log in an operation log file by date of creation or time.

Latest display of the list Updates the operation log list.
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(3) CSV file conversion or Unicode text file conversion of operation log file
The following shows how to convert an operation log file (*.G2O) into a CSV file or a Unicode text file.

(a) Converting with GT Designer3
Step 1 Save an operation log file (*.G2O) to the personal computer by either of the following methods.

• Transferring with GT Designer3
Select [Communication] → [Read from GOT...] from the menu to transfer a file to the personal computer.

➟4.3.2 ■3 Reading the data from the GOT
• Transferring with a data storage

Save an operation log file to a data storage and read it using the personal computer.
➟GOT2000 Series User's Manual (Utility)

Step 2 Select [Tools] → [Resource Data Conversion] → [Operation Log File...] from the menu to display the 
[Operation Log File Conversion] dialog.
Refer to the following to enter the required items.

➟5.2.11 ■6 [Operation Log File Conversion] dialog

(b) Converting in the utility
Step 1 Start the GOT and touch the [Program/Data management] tab.
Step 2 Touch the [Operation Log Information] to display the [Operation Log Information] screen.

Step 3 Select a file to convert, and touch either of the following buttons.
• [G2O→CSV] button

Converts an operation log file (.G2O) into a CSV file.
• [G2O→TXT] button

Converts an operation log file (.G2O) into a Unicode text file.

[Data management] tab

[Operation log information] button
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Step 4 A file which is converted is saved in the same location as an operation log file (*.G2O).

(c) Converting with the Trigger File Conversion device
To convert an operation log file (*.G2O) in which events are being collected into a CSV file, turn on the Trigger File 
Conversion device with a bit switch or others.
Set the Trigger File Conversion device on the [File Conversion] tab in [Operation Log].

➟5.2.11 ■5 (3) [File Conversion] tab
Check the file conversion status using the Notify Operation Log Status device.

➟(4) Checking the operation log status

(4) Checking the operation log status
Check the operation log status by using the Notify Operation Log Status device.
Set the Notify Operation Log Status device on the [Basic] tab for [Operation Log] in the [Environmental Setting] window.

➟5.2.11 ■5 (1) [Basic] tab
The following shows the details of the Notify Operation Log Status device.

Set the Trigger File Conversion device and the automatic operation log file conversion on the [File Conversion] tab for 
[Operation Log] in the [Environmental Setting] window.

➟5.2.11 ■5 (3) [File Conversion] tab

(5) Outputting operation log data to a report screen
You can output operation log data to a report screen.
For the report function, refer to the following.

➟10.11 Outputting the Collected Data as a Report (Report Function)

[G2O→CSV] button
[G2O→TXT] button

Bit number Description

b0 Turns on when operation events cannot be collected. Turns off when collecting operation events is enabled.

b1 to b7 Use prohibited

b8

Turns on when an operation log file conversion is started by using the Trigger File Conversion device. Turns off 
when the conversion is completed and the Trigger File Conversion device turns off.

b9 Turns on when an automatic operation log file conversion is started. Turns off when the conversion is completed.

b10 to b15 Use prohibited

Trigger File
Conversion device

Notify Operation Log
Status device (b8)

Operation log
 file conversion

CompletedStarted

ON

ON OFF

OFF
5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])

5 - 187



■3 Recording the operator name as the character string stored in the device

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
The operator name, substituted by the user-defined character string stored in the specified device, is recorded in the 
operation log.
The character string specified using this function is prioritized over the operator name to be recorded when the screen 
security authentication method is operator authentication or level authentication.

Example 1) This function is disabled while the operator authentication method is selected for screen security.

Example 2) This function is enabled while the operator authentication is selected for screen security.

(1) Operation logs in which the operator name is substituted by a character string
This function is available for operation logs in which the operator name (output item: OPERATOR) is recorded.

➟5.2.11 ■1 (2) Output items of operation logs
Note that this function is not available for operation logs when:

• A login attempt for the operator authentication fails.
• An operator switching for the operator authentication fails.
• An operator account for the operator authentication is locked.
• The operator management information is changed.

The operator name is not substituted by a character string for the operations performed on a VNC client or GOT Mobile 
function client.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Authentication method: Operator authentication
Operator name: User1
Operator ID: 10

Base screen 1

Base screen 2

Switch the screen to base screen 2

OPERATOR OPE_ID
User1 10

CHG_VALUE
BASE_2

The name and ID of the operator 

who is logging in are recorded.

Authentication method: Operator authentication
Operator name: User1
Operator ID: 10

Base screen 1

Base screen 2

Switch the screen to base screen 2

OPERATOR OPE_ID
Master 0

CHG_VALUE
BASE_2

Device for storing the character string: GD2000
Stored string: Master

The user-defined character string is recorded 

as the operator name.

For the operator ID, 0 (fixed) is recorded.
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(2) Substituting the operator name with a character string
Select [Record [Contents]-[Operator Name] with the strings stored in the device (up to 16 characters)] on the [Log Target] 
tab in [Operation Log], and set [Device (8 points)].

➟5.2.11 ■5 [Operation Log...]
Store a character string in eight consecutive word devices starting from a specified device.
Store the character string in the ASCII code (0x20 to 0x7E) in order from the lower to the upper bit of each device.
Store Null (0x00) at the end of the character code.

(3) Timing at which the substituting operator name is recorded in the operation log
After a character string is stored in the device, the substituting operator name is recorded in the operation log.

■4 Precautions

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

(1) Log target when recording an operation log per object
Do not select [Object] in the [Log Target] tab of the operation log setting.
Doing so sets all the objects as the target of the operation log function.
To record an operation log per object, select [Operation Log Information] in each object setting.

(2) Target function for an operation log
Do not set the function which is not set in GT Designer3 as the target of the operation log.
Doing so may record an operation log even though the function does not operate.

(3) System language when converting an operation log file (*.G2O)
When [System Language Switching Interlock] is set for [File Conversion Language] in the operation log setting, an 
operation log file is not converted in the language specified in the system language switching device.
A file is converted in the system language set in the utility.

(4) Converting an operation log file (*.G2O) in the utility
When converting an operation log file (*.G2O) into a CSV file or a Unicode text file in the utility, execute a conversion by 
each file.
Even if multiple files are selected at once, they cannot be converted.

(5) Operation log file size
The file size of an operation log cannot be calculated in advance.
To use a data storage in other functions as well, limiting the capacity used for an operation log file by setting [Specify the 
total log file size] in GT Designer3 is recommended.

(6) Converting an operation log file (*.G2O) in a language other than Japanese and English
Before converting an operation log file (*.G2O) in a language other than Japanese and English to a CSV file, turn on the 
Character Code for CSV Conversion signal (GS522.b2).
If this signal (GS522.b2) is not turned on, the characters are not displayed correctly.
For the details of the Character Code for CSV Conversion signal (GS522.b2), refer to the following.

➟12.1.3 GOT special register (GS)

(7) Substituting the operator name
If you perform another operation before storing a character code in the device, the substituting operator name is not 
recorded in the operation log.
Make sure that a character code is stored in the device in advance.
While the GOT is being started or restarted, if an operation log is recorded at any of the following timing, the operator 
name may be left blank.

• Obtaining the authority
• Releasing the authority
• Failing to obtain the authority

For details on substituting the operator name with a character string, refer to the following.
➟5.2.11 ■3 Recording the operator name as the character string stored in the device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(8) To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

(9) CSV file conversion or Unicode text file conversion of operation log file in GT21
When any communication driver other than the following is used, [??] is displayed in the device name after the file 
conversion.

• [Serial(MELSEC)]
• [MELSEC-FX]
• [Ethernet(MITSUBISHI ELECTRIC), Gateway]
• [Ethernet(FX), Gateway]
• [CC-Link(G4)]
• [MODBUS/RTU Master]
• [MODBUS/TCP Master, Gateway]

In GT Simulator3, [??] is displayed in the device name after the file conversion regardless of the communication driver 
type.

(10)Recording of the operation log at a communication error in GT21
If a communication error occurs at writing data to the device using an object, the operation log is not recorded.
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■5 [Operation Log...]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
In [Operation Log...], configure the setting for saving the operation history of the GOT.
Select [Common] → [GOT Environmental Setting] → [Operation Log...] from the menu to display this window.
After displaying the window, select [Collect operation logs].

➟5.2.11 ■5 (1) [Basic] tab
　 5.2.11 ■5 (2) [Log Target] tab
　 5.2.11 ■5 (3) [File Conversion] tab
5.2.11 ■5 (4) [Report Setting] tab

(1) [Basic] tab

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

1) [Save To]
Select the destination to save an operation log file (.G2O).
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Select.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

6)

5)

4)

7)
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2) [Folder Name]
Set the name of the folder to which the operation log file (.G2O) is saved.
For the character type and the number of characters available for folder names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
3) [File Name]

Set the file name of the operation log file (.G2O).
The log collection start date (YYYYMMDD) for the file and the version are added automatically to the set file name.
For the character type and the number of characters available for file names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
4) [Notify the operation log status]

Set devices for notifying the collecting status of the operation log.
The word device is available.
For the details of the Notify Operation Log Status device, refer to the following.

➟5.2.11 ■2 (4) Checking the operation log status
5) [Log file switching timing]

Set the switching mode, time, and storage period for the save destination file of the operation log.

6) [Log file size]
Set the upper limit capacity of all the operation log files (.G2O) in the save destination folder and the operation when 
the capacity is insufficient.

7) [Display the screen image when using operation logs]
Not available to GT21 and GS21.
Displays the screen image of the operation log selected in the operation log information screen.
For the screen image, refer to the following.

➟GOT2000 Series User's Manual (Utility)

Item Description

[Switching Mode]

Select the switching mode for the save destination file of the operation log. The following 
shows the items to be selected.
• [Daily]:

Switches the save destination file once a day.
• [Weekly]:

Switches the save destination file once a week.
After selecting this item, select the day to switch.

[Switching Time] Set the time to switch the save destination file. Set the time by minutes.

[Log File Retention Period]

Set the storage period of the operation log file (.G2O). The following shows the setting 
range.
• When [Daily] is selected for [Switching Mode]: [7] days to [100] days
• When [Weekly] is selected for [Switching Mode]: [4] weeks to [53] weeks

Item Description

[Specify the total log file size]
Set the upper limit capacity of all the operation log files (.G2O) in the save destination 
folder. When the capacity of all the operation log files exceeds the set capacity, the oldest 
operation log file is deleted. The setting range is [10] MB to [1024] MB.

[Behavior when memory card runs out of 
space]

Select the operation if the capacity is insufficient when a file is saved. The following shows 
the items to be selected.
• [Delete existing logs and continue to collect logs]
• [Delete existing logs and collect no further logs]
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(2) [Log Target] tab

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

1) [Function]
Lists the items which can be set as the target of the operation log.
The items in this list are not recorded in the operation log file.
For the details of each function, refer to the following.

➟5.2.11 ■1 (1) Target operations for recording operation logs
2) [Operation Log Target]

Lists the items which are set as the target of the operation log.
The items in this list are recorded in the operation log file.

3) Buttons
The following buttons are used for selecting or deleting items.

4) [Collect previous device values at the time of touch switch operation]
Logs the previous device value with each touch switch operation.

5) [Collect operation logs of clients being connected to the server of GOT Mobile function]
Not available to GT23, GT21, and GS21.
Logs operations performed on the client in the GOT Mobile function.
The operation log is saved in the GOT.

6) [Record [Contents]-[Operator Name] with the strings stored in the device (up to 16 characters)]
The operator name, substituted by the user-defined character string stored in the specified device, is recorded in 
the operation log.
For the operator ID, 0 is recorded.

➟5.2.11 ■3 Recording the operator name as the character string stored in the device
7) [Device (8 points)]

Specify the first device of consecutive word devices to which a character string is stored.

Item Description

[Select] button Moves the item selected in [Function] to [Operation Log Target].

[Delete] button Moves the item selected in [Operation Log Target] to [Function].

[Select All] button Moves all the items in [Function] to [Operation Log Target].

[Delete All] button Moves all the items in [Operation Log Target] to [Function].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
5)
6)
7)
8)
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Eight consecutive devices starting from a specified device are used.
8) [Operation Name of Objects]

Not available to GT21 and GS21.
Set the items to be recorded as OPNAME for an object.
Click the [...] button to display the [Operation Name Setting] dialog.

(3) [File Conversion] tab

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

1) [File Convert Trigger Device]
Set a trigger device to convert an operation log file (.G2O) in which events are being collected into a CSV or Unicode 
text file.
The bit device is available.

2) [Automatically convert when switching log files]
Converts a file automatically when recording an operation log file (.G2O) is completed.

• [Item]
Select an item to be recorded as OPNAME for an object.
The following shows selectable items.
· [Name]

Records the name specified in the setting dialog of an object.
· [Object ID]

Records the ID number of an object.
· [Text]

Records the text displayed on a touch switch.
When [Text Type] is set to [Text], only the centered text will be 
recorded.
This setting is applied to a touch switch only.

• [Order]
Set the order in which the selected items are recorded as OPNAME 
for an object.
The setting range is [1] to [3].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

5)

4)
3)

2)

6)

Operation log file (G20)

Unicode text file or CSV file

File 1 File 2

Automatic 
conversion

File 1 is automatically converted 
to Unicode/CSV at the creation 
of a new operation log file.
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3) [Format]
Select the file format after the conversion.
The following shows the items to be selected.

• [Unicode Text]
• [CSV]

4) [Specify the date/time format for file output]
Specify the date and time format for a conversion destination file.
Click the [...] button to specify the date and time format in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings
5) [Save To]

Select the save destination folder for a converted file.
The following shows the items to be selected.

• [Same as log file]:
Saves a file in the same folder as that of an operation log file (.G2O).

• [Change]:
Set the destination to save a file.
After selecting this item, set [Drive Name] and [Folder Name].

6) [File Conversion Language]
Select the language of the file after conversion.
The following shows the items to be selected.

• [System Language Switching Interlock]
Converts the file in the same language as the system language.

• [Fixed]
Converts the file in the selected language.
The selectable languages differ depending on the file format of the file after conversion and the GOT model.

Item Description

[Drive Name]

Set a drive to save a converted file. The following shows the items to be selected.
• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

[Folder Name]
Set the folder name of the destination to save a file. For the character type and the number 
of characters available for folder names, refer to the following.
• 12.4 Restrictions for Folder Names and File Names used in GOT

[File Name] The file name after the conversion is displayed.

GOT
The file format of the file after conversion

Unicode text CSV

GT27
GT25
GT23
GT SoftGOT2000
GS25

[Japanese]
[English]
[Chinese(Simplified)]
[Chinese(Traditional)]
[Korean]

[Japanese]
[English]

GT21
GS21

[Japanese]
[English]
[Chinese(Simplified)]
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(4) [Report Setting] tab

1) [Output operation logs to a report screen]
Outputs operation log lines to a report.
For setting an operation log line, refer to the following.

➟10.11.3 ■5 Settings to output operation log lines
2) [Output Language]

Select a language in which a report is output.
The following shows selectable items.

• [Japanese]
• [English]

3) [Contents]
Set items to be output.

Item Description

[Attribute]

Select attributes to be output.
The following shows selectable items.
• [Date/Time]
• [Screen No.]
• [Function Abbreviation]
• [Function Type Name]
• [Operation Name]
• [Operator Name]
• [Operator ID]
• [User ID]
• [Action No./Setting ID]
• [Data Type]
• [Device Name]
• [Changed Value]
• [Changed Value (Operation)]
• [Original Value]
• [Original Value (Display)]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

3)

2)
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4) [Preview]
Displays a preview of the operation log data to be output to a report.
Select a preview format.
The following shows selectable items.

• [Preview value]
Displays the values of the selected attributes in [Preview].

• [Attribute name]
Displays the selected attributes in [Preview].

[Digits]

Specify the number of digits of text to be output.
The following shows selectable items.
• [Self-adjust]

Adjusts the number of digits of text automatically.
• [Fixed]

Specify the number of digits of text.
The setting range is [1] digit to [124] digits.

[Order] Set the order in which attributes are output.

[Linefeed]

Set whether to insert a line feed after an attribute value.
If the number of digits of attribute values to be output exceeds the maximum number of 
digits per line, insert line feeds to output the values in multiple lines.
The maximum number of digits per line is specified with [Page Columns] in the [Report 
Setting] dialog.
The following shows selectable items.
• [Yes]
• [No]

[Preview Format]

Displays the format in which an attribute value will appear in [Preview].
When [Date/Time] is selected, the date and time format is settable.
Click the [...] button to specify the date and time format in the [Date/Time Setting] dialog.
For the details, refer to the following.

➟6.3.2 Date/time format settings

Item Description
5. COMMON SETTING
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■6 [Operation Log File Conversion] dialog

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

1) [Source of Conversion]
Set the destination to save the conversion source file and the target file.

2) [Destination File]
Set the file format of the converted file and the destination to save the file.

■7 Relevant settings

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Set the relevant settings other than the specific settings for the operation log as required.
The following shows the functions that are available by the relevant settings.

(1) Internal device
➟12.1.3 GOT special register (GS)

Item Description

[Type] The conversion source file type. [G2O] is displayed.

[Path] Set the destination path to save the conversion source file.

[Convert all operation log files in the same 
path]

Select this item to set all the operation log files (.G2O) in the conversion source folder as 
the target of the conversion.

Item Description

[Type]

Set the file format and the language of the converted file. The settable language depends 
on the selected file format. The following shows the items to be selected.
• [CSV]

Converts an operation log file (.G2O) into a CSV file.
[Japanese] or [English] can be selected for the language.

• [Unicode]
Converts an operation log file (.G2O) into a Unicode text file.
For GT27, GT25, GT23, GT SoftGOT2000, or GS25, [Japanese], [English], 
[Chinese(Simplified)], [Chinese(Traditional)], or [Korean] can be selected for the 
language.
For GT21 and GS21, [Japanese], [English], or [Chinese(Simplified)] can be selected.

[Convert] Set the destination path to save the converted file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Changing the character code to Unicode when a binary file is converted to CSV format GS522.b2

Disabling all buttons except the [List] and [Latest] buttons on the [Operation Log 
Information] screen of the utility GS522.b3

Changing the date format used for the operation log information of the utility GS632.b0, GS632.b1
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5.2.12 Configuring the settings for retaining GOT internal device data at power failure 
([Internal Device Retention])

Not available to GT2103-P.
➟■1 Specifications of the internal device retention
■2 How to use the internal device retention function
■3 [Internal Device Retention]

The GOT internal device values are saved to the built-in memory (SRAM) of the GOT.
The GOT retains the device values monitored before power-off of the GOT, and monitors the retained values again upon 
power-on of the GOT.
GT SoftGOT2000 saves device values at the specified intervals or when the software exits.
For information on how to set the timing for saving device values, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

■1 Specifications of the internal device retention

Not available to GT2103-P.

(1) Devices used for the internal device retention
The following shows the devices used for the internal device retention and device range.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device Range

GOT bit register (GB)

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
GB64 to GB65535

• For GT21
GB64 to GB2047

GOT data register (GD)

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
GD0 to GD65535

• For GT21
GD0 to GD2047
5. COMMON SETTING
5.2 Setting the GOT Basic Operations ([GOT Environmental Setting])

5 - 199



■2 How to use the internal device retention function

Not available to GT2103-P.

(1) How to set the internal device retention function
Configure the settings on GT Designer3 in the following procedure.

Step 1 Select [Common] → [GOT Environmental Setting] → [Internal Device Retention] from the menu to display 
the [Environmental Setting] window ([Internal Device Retention]).

➟5.2.12 ■3 [Internal Device Retention]
Step 2 Specify the start device of consecutive devices and the number of devices for saving their data to the SRAM, 

and click the [OK] button.
Step 3 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
In GT SoftGOT2000, the timing for saving device values is settable.

➟GT SoftGOT2000 Version1 Operating Manual

(2) Specifications of the SRAM
GT27, GT25, GT23, GT SoftGOT2000, and GS25 use the SRAM user area for saving device values.
For the specifications of the SRAM user area, refer to the following.

➟12.12 Specifications of the SRAM user area
GT21 uses the system area of the SRAM for saving device values.
The data capacity to be stored in the system area is unnecessary to be considered.

(3) Cases where device values in the SRAM are deleted or backed up
The device values saved in the SRAM will be deleted in the following cases.

• Project data is written to the GOT when [Initialize SRAM user area when writing project data/OS] is selected in the 
[Communicate with GOT] dialog (for GT27, GT25, GT23, and GS25).

• The SRAM is initialized by using [SRAM management] of the utility (for GT27, GT25, GT23, and GS25).
• The SRAM is initialized by using [Clear data] of the utility (for GT21).
• Any setting in the [Environmental Setting] window ([Internal Device Retention]) is changed, and then the project data 

is written to the GOT.
• Project data having a different project ID is written to the GOT.
• The battery is removed or runs out.

For GT27, GT25, GT23, and GS25, backup or restore the data in the SRAM by using the [SRAM management] of the 
utility.
For the details of the backup/restoration, refer to the following.

➟GOT2000 Series User's Manual (Utility)
For the setting to delete the device values in the SRAM on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [Internal Device Retention]

Not available to GT2103-P.
Set the ranges of devices to save their data to the SRAM in [Internal Device Retention].
To display the following window, select [Common] → [GOT Environmental Setting] → [Internal Device Retention] from 
the menu.

1) [Bit Device (GB)]
Saves the values of GOT bit registers (GB) to the SRAM.

2) [Word Device (GD)]
Saves the values of GOT data registers (GD) to the SRAM.

Item Description

[First Device]

Specify the start device of GOT bit registers.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

[GB64] to [GB65535]
• For GT21

[GB64] to [GB2047]

[Points]

Specify the number of GOT bit registers.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

[1] to [65472]
• For GT21

[1] to [1984]

Item Description

[First Device]

Specify the start device of GOT data registers.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

[GD0] to [GD65535]
• For GT21

[GD0] to [GD2047]

[Points]

Specify the number of GOT data registers.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

[1] to [65536]
• For GT21

[1] to [2048]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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5.2.13 Configuring the settings to convert a text into kanji or Simplified Chinese 
characters in the GOT ([Kana-Kanji/Pinyin Conversion])

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

➟■1 Specifications of Kana-Kanji/Pinyin conversion
■2 How to use Kana-Kanji/Pinyin conversion
■3 Precautions
■4 [Kana-Kanji/Pinyin Conversion]
■5 Relevant settings

A text entered with a text input object can be converted into kanji or Simplified Chinese characters.
The following shows the conversion methods.

• Kana-Kanji conversion: Hiragana to kanji
• Pinyin conversion: Pinyin (lowercase alphabetic characters) to Simplified Chinese

Use a touch switch for which key codes for Kana-Kanji/Pinyin conversion are set or a keyboard for Kana-Kanji/Pinyin 
conversion to convert a text.

Example) Converting hiragana characters into kanji characters

■1 Specifications of Kana-Kanji/Pinyin conversion

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

(1) Conditions that enable KANA-KANJI conversion
The KANA-KANJI conversion will be enabled by using a text input object that satisfy all the following conditions.

• Selecting [Kana-Kanji/Pinyin Conversion] in the [Extended] tab in the [Text Input] dialog
• Selecting [Kana-Kanji] for [Conversion Method] in [Kana-Kanji/Pinyin Conversion] in the [Environmental Setting] 

dialog
• Setting the character code and system language

The following shows the combinations of character codes and system languages that are available for Kana-Kanji 
conversion.

*1 It changes the character code used for text input.

➟12.1.3 ■5 (36) Character Code Control (GS456)
*2 When the character code other than [System Language Link], [Unicode], or [S-JIS] is set, KANA-KANJI conversion is enabled. 

However, the GOT cannot display the converted characters correctly.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

変換 変換

Input the hiragana characters 
by ASCII input.

変換

The hiragana characters are 
converted into the kanji characters.

せいさん 生産せいさん

Touch the [Conversion] switch.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Value in Character Code Control 
(GS456)*1 GOT system language [Character Code] in the [Device/Style] tab in 

the [Text Input] dialog*2

0 Japanese

[System Language Link]
[Unicode]
[S-JIS]1

• Japanese
• English
• Chinese (Simplified)
• Chinese (Traditional)
• Korean
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(2) Conditions that enable Kana-Kanji/Pinyin conversion
Kana-Kanji/Pinyin conversion is enabled by text input that satisfies all the following conditions.

• Selecting [Kana-Kanji/Pinyin Conversion] in the [Extended] tab in the [Text Input] dialog
• Selecting [Pinyin Simplified Characters] for [Conversion Method] in [GOT Environmental Setting] → [Kana-Kanji/

Pinyin Conversion]
• Setting the character code and system language

The following shows the combinations of character codes and system languages that are available for Pinyin 
conversion.

*1 It changes the character code used for text input.

➟12.1.3 ■5 (36) Character Code Control (GS456)
*2 When the character code other than [System Language Link], [Unicode], or [GB] is set, Pinyin conversion is enabled. However, 

the GOT cannot display the converted characters correctly.

(3) Input mode
Hiragana-input is supported.
Input texts on objects by using the touch switch (key code switch).

(4) Conversion method
A range of phrase can be converted.
Characters are converted when the input characters match the dictionary data completely.

When the Conversion switch is touched once, one conversion option is displayed. When the switch is touched again, the 
option selection window appears and shows more options.

(5) Number of characters that can be input and converted at once
Up to 40 two-byte characters (80 bytes) can be input.
Up to 20 two-byte characters (40 bytes) can be converted.

(6) Supported Kanji
• Kana-Kanji conversion

Kanji characters classified in the JIS Level-1 kanji set and JIS Level-2 Kanji set are supported.
• Pinyin conversion

GB2312 Chinese characters are supported.

Value in Character Code Control 
(GS456)*1 GOT system language [Character Code] in the [Device/Style] 

tab in the [Text Input] dialog*2

0 Chinese (Simplified)

[System Language Link]
[Unicode]
[GB]3

• Japanese
• English
• Chinese (Simplified)
• Chinese (Traditional)
• Korean

せいさんらいん 生産

変換 Touch the           switch. Convert "せいさん" and 
"らいん" separately.

変換変換

ライン

Example) Entering [せいさんらいん] and converting it using Kana-Kanji conversion

三菱

 
みつびし

 

When the Conversion switch is 
touched once, one conversion 
option is displayed.

When the switch is touched again, 
the option selection window is 
displayed.

次 次次

三菱
三菱

ミツビシ
みつびし
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(7) Learning conversion results
The GOT learns Kana-Kanji conversion results and Pinyin conversion results.
No setting is required for the GOT to learn conversion results.
The GOT holds the learning result until the GOT is powered off or reset.
Up to 20 two-byte characters (40 bytes) can be learned.
Up to 1000 words can be learned.

(8) Operation switch
The touch switch used for Kana-Kanji/Pinyin conversion operates when key codes are assigned.
When creating a key window by the use, use the following key codes.

Item Key code Application and operation

Hiragana characters Shift JIS code Use for inputting hiragana characters.

Cursor key (Left) 0091h

Use for moving a cursor.
• While characters are input, a cursor is moved to the left for one character.

• While characters are converted, the selected phrase is shortened by one character by 
pressing this switch.

Cursor key (Right) 0090h

Use for moving a cursor.
• While characters are input, a cursor is moved to the right for one character.

• While characters are converted, the selected phrase is extended by one character by 
pressing this switch.

While characters are converted, touch this key and then enter a sonant mark or p-sound 
mark to input the mark as one character.

[DEL] key 0008h

Use for deleting characters.
• While characters are input, the right-most input character is deleted.

• While characters are converted, the conversion result on the selected strings is undone 
and returned to its original characters.

[CLR] key 0088h

Use for clearing characters.
• While characters are input, all the input characters are cleared.

• While characters are converted, only the characters being converted are cleared.

三菱 三菱

みつびし みつびし

三菱 三菱

みつびしみつびし

みつひみつひ 〟 〝

DEL
三菱 三

DEL
三菱 みつびし

三菱電機
CLR

三菱電機
CLR

三菱
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[Kanji/Simplified Character 
Conversion] key 0084h

Use for converting characters.
• While characters are input, the characters are converted.

• While characters are converted, the conversion result on the selected strings is undone 
and returned to its original characters.

[Option] key
([The former candidate] or 
[The next candidate])

0085h or 0086h

Use for displaying the option selections.
• When this key is touched first, the next option selection is displayed.

• When this key is touched again, the option selection window is displayed.

[>>] key 0087h

Use for selecting the next phrase during the conversion.
• When a single phrase is converted, the input characters are determined.

• When a range of phrase is converted, the next phrase is selected.

[<<] key 0089h

Use for selecting the previous phrase during the conversion.
• While a single phrase is converted, the original characters are displayed.
• When a range of phrase is converted, the previous phrase is selected.

[Enter] key 000Dh

Use for writing characters to the device.
• While characters are input and converted, the displayed characters are determined.

• After the conversion the characters are input to the device.

Item Key code Application and operation

みつびし
変換

三菱

変換
三菱 みつびし

候補
みつびし 三菱

候補
三菱 三菱

三菱

みつびし

ミツビシ

選択
三菱 三菱

＞＞
三菱 三菱でんき でんき三菱でんき

＜＜
三菱 三菱でんき でんき三菱 でんき

確定
三菱 三菱

確定
三菱 三菱
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(9) Option selection window
The option selection window displays multiple conversion options in a list at the conversion.
The background color and the scroll button can be selected.
The background color can be selected from [White] or [Black].
The scroll button can be selected from [Page + Line Scroll] or [Page Scroll].

■2 How to use Kana-Kanji/Pinyin conversion

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
The following settings are required to use Kana-Kanji/Pinyin conversion.

• Key window settings
➟(1) Setting a key window

• Text input object settings
➟(2) Setting an object

(1) Setting a key window
Perform one of the following operations to set a key window.

• Using a key window for text (key window that supports Kana-Kanji/Pinyin conversion)
Not available to GT21 and GS21.
When GS467.b1 is on, the key window displayed at a touch of an text input object is switched to a key window that 
supports Kana-Kanji/Pinyin conversion.
Set a bit switch or other objects and turn on GS467.b1.

➟5.2.4 ■1 (5) Key window for text (key window that supports Kana-Kanji/Pinyin conversion) (GT27, GT25, GT 
SoftGOT2000, and GS25)

• Using a user-created key window
Create a key window for Kana-Kanji/Pinyin conversion.
KANA key and conversion keys registered in the library can be used.

➟2.5.1 ■2 Creating a window screen
5.2.4 Setting key windows ([Key Window])
8.1.2 ■1 Using the data in the library

Use either of the following methods when using the option selection window as well.
• Setting by the project

Select [Common] → [GOT Environmental Setting] → [Kana-Kanji/Pinyin Conversion] from the menu to display the 
[Kana-Kanji/Pinyin Conversion] window, and select [Option Selection Window].

➟5.2.13 ■4 [Kana-Kanji/Pinyin Conversion]
• Setting by screen

Select [Screen] → [Screen Property] from the menu to display the setting dialog, and select [Use the option selection 
window] in the [Option Selection Window] tab.

➟2.7.1 Property of base screens
2.7.2 Properties of window screens

(2) Setting an object
Configure the settings to enable Kana-Kanji/Pinyin conversion for a text input object placed on the screen.

➟8.5.5 ■2 [Extended] tab

Background color: [White] 

Scroll: [Page + Line Scroll]

Background color: [Black] 

Scroll: [Page Scroll]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Precautions

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

(1) Number of input digits for the text input
Do not exceed the number of input digits set in the text input.
Otherwise, determining the characters and writing to a device cannot be executed.

(2) Input by the USB keyboard
When using Kana-Kanji conversion or Pinyin conversion, data entry to a text input object using a USB keyboard is not 
available.
Use the key window displayed on the GOT screen.

(3) System application (extended function) setting
Kana-Kanji/Pinyin conversion does not work if the system application (extended function) for [Kana-Kanji/Pinyin 
conversion] is not installed on the GOT.
For how to add a system application to be installed on the GOT, refer to the following.

➟4.2 Setting a System Application to be Written to the GOT

(4) Precautions for Pinyin conversion
The four tones are not supported.
Uppercase alphabetic characters cannot be converted into Simplified Chinese characters.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Kana-Kanji/Pinyin Conversion]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Set how to display the option selection window in [Kana-Kanji/Pinyin Conversion].
Select [Common] → [GOT Environmental Setting] → [Kana-Kanji/Pinyin Conversion] from the menu to display the 
window.

1) [Conversion Method]
Select a conversion method.

• [Kana-Kanji]
• [Pinyin Simplified Characters]

2) [Use the option selection window]
Select this item to display the option selection window at Kana-Kanji conversion or Pinyin conversion.

3) [Background Color]]
Select the background color of the option selection window.

4) [Scroll]
Select the key to be displayed in the option selection window.

• [Page + Line Scroll]: Displays the key to scroll the screen by page and line.
• [Page Scroll]: Displays the key to scroll the screen by page.

5) [Preview]
Displays the preview of the option selection window which the settings of [Background Color] and [Scroll] are 
reflected.

■5 Relevant settings
(1) GOT Internal Device

➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)

5)

Function Setting item

Switching a key window for text input to a key window that supports Kana-Kanji conversion or 
Pinyin conversion

Not available to GT21 and GS21.
GS467.b1
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5.2.14 Setting a screen to be displayed on the GOT at startup ([Startup Logo])

➟■1 Specifications of the startup logo
■2 How to use the startup logo
■3 Precautions
■4 [Startup Logo]

Images in BMP or JPEG format can be displayed as the startup logo at GOT startup.

■1 Specifications of the startup logo

(1) Available number of startup logos
A startup logo can be set for each project.

(2) Applicable image file
BMP files and JPEG files are applicable.
When an image file whose format is incompatible with the GOT is set, the pre-installed startup logo is displayed.

(a) BMP file

(b) JPEG file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

ABC factory ABC factory 

Line control systemLine control system

ABC factory ABC factory 

Line control systemLine control system

The set images in BMP or JPEG 
format is displayed at GOT startup.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Format 24-bit BMP

Number of colors BMP files in 65536 or less colors can be displayed. The colors which cannot be displayed on the GOT are 
subtracted.

Resolution
Images whose resolutions are lower than that of the GOT can be used. When the resolution is higher than 
that of the GOT, the GOT displays only the part that lies within the screen by using the center of the image 
as the reference.

Item Description

Format Base line JPEG compatible with RGB full-color (Progressive JPEG and lossless JPEG are unavailable.)

Number of colors JPEG files in 65536 or less colors can be displayed. The colors which cannot be displayed on the GOT 
are subtracted.

Resolution
Images whose resolutions are lower than that of the GOT can be used. When the resolution is higher than 
that of the GOT, the GOT displays only the part that lies within the screen by using the center of the image 
as the reference.
5. COMMON SETTING
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■2 How to use the startup logo

(1) Outline procedure of setting
Step 1 Select [Common] → [GOT Setup] → [Basic Setting] → [Display Setting/Language Setting] from the menu to 

display the [GOT Setup] window, and set the display time of the startup logo in [Title Display Time].

➟5.2.14 ■4 [Startup Logo]
You can also set the display time in the utility.

➟GOT2000 Series User's Manual (Utility)
Step 2 Install the package data on the GOT.

For GT SoftGOT2000, the installation is not required.
Step 3 The set image file is displayed as the startup logo at GOT startup.

For GT SoftGOT2000, when the saved project is opened, the set image file is displayed as the startup logo.

■3 Precautions

(1) Precautions for utilizing a project
When you utilize a project where the GOT installation orientation is set to [Vertical], set the startup logo again.
Otherwise, the utilized startup logo is rotated and appears in the destination project.

■4 [Startup Logo]

In [Startup Logo], set an image file to be displayed at GOT startup.
Select [Common] → [GOT Environmental Setting] → [Startup Logo] from the menu to display this window.

1) [Specify Startup Logo]
Select this item to set an image file used as the startup logo.

2) [Select an image] button
Displays the [Open] dialog.
Select a BMP file or JPEG file to be used as the startup logo.
For the details of available image files, refer to the following.

➟5.2.14 ■1 Specifications of the startup logo
3) Preview

Displays the preview of the image file set as the startup logo.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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5.3 Setting the Utility Function ([GOT Setup])

➟5.3.1 Configuring the settings of the display of the GOT ([Display Setting/Language Setting])
5.3.2 Setting the identification information to the GOT ([GOT ID No.])
5.3.3 Configuring the settings for the touch operation on the GOT ([Operation Setting/Utility Call Key])
5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])
5.3.5 Setting the GOT time setting method ([Time Setting])
5.3.6 Setting the FA transparent function ([Transparent Mode Setting])
5.3.7 Configuring the settings of the GOT internal device monitor ([GOT Internal Device Monitor])
5.3.8 Configuring the settings of the SoftGOT-GOT link function ([SoftGOT-GOT Link])
5.3.9 Configuring the settings of the VNC server function ([VNC Server])
5.3.10 Configuring the settings of the sequence program monitor ([Sequence Program Monitor])
5.3.11 Configuring the settings of the backup/restoration function ([Backup/Restore])
5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
5.3.13 Configuring the settings of the system launcher function ([System Launcher])
5.3.14 Configuring the settings of the iQSS utility function ([iQSS Utility])
5.3.15 Configuring the network drive settings ([Network Drive])

Use [GOT Setup] to configure the utility settings with GT Designer3 in advance.
With the GOT setup, the GOT operations and the utility functions, such as the display method of screen, the manage 
method of the clock, and the buzzer sound length, can be set.
The settings are reflected to the GOT after the package data is written into the GOT.
The settings can be reconfigured in the utility.
For the operations and settings of the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)
When the GOT setup is enabled, settings changed in the utility are reflected to the project as well.
(Otherwise, the changed settings are not reflected to the project.)
When the project is read from the GOT to GT Designer3 after the settings are changed in the utility, the setting contents 
in the [GOT Setup] are changed as well.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.1 Configuring the settings of the display of the GOT ([Display Setting/Language 
Setting])

➟■1 Specifications
■2 [Display Setting/Language Setting]

In [Display Setting/Language Setting], configure settings for the GOT display and the system language.

■1 Specifications

(1) Screen saver
The screen saver function is designed to turn off the screen display if the screen is not touched within a specified time.
The screen saver mode can be canceled by the screen touch operation, the human sensor, and the system information.
Example) When the time to the screen saver is set to 10 minutes

For how to control the screen saver function with the system information, refer to the following.
➟5.2.5 ■2 (6) Control screens

(2) Human sensor
Available to GT27-X and GT27-S.
The human sensor is a sensor that detects the human approach.
Use the human sensor to release the screen saver mode.
By approaching the GOT, the screen saver mode can be canceled.

The human sensor operation can be controlled with the system information as well.
For how to control the human sensor with the system information, refer to the following.

➟5.2.5 ■2 (6) Control screens

(3) Brightness adjustment mode
You can change the brightness adjustment mode of the backlight by selecting [Normal] or [Low].
To reduce the luminous intensity of the GOT screen, select [Low] instead of [Normal] for [Brightness Adjustment Mode].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Line No.1
F 1254

G 348

F 1254

G 348

10 minutes
     later

Touch the 
screen

Line No.1
F 1254

G 348

F 1254

G 348

Screen saving is started. Screen saving is canceled.

Line No.1
F 1254

G 348

F 1254

G 348

Cancels the screen saver mode 
when by detecting the human approach
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To use the [Low] mode, install the BootOS version E or later on the GOT. (Not applicable to GT21 and GS21)
For how to install the BootOS, refer to the following.

➟4.3.2 ■1 Writing data to one GOT

Restrictions in [Low] mode
(1) Backlight failure detection

When the brightness adjustment mode is set to [Low] mode, the GOT cannot detect the backlight failure.
To detect the backlight failure, set the brightness adjustment mode to [Standard].

(2) Screen display
In [Low] mode, the screen may flicker, or the screen display may turn off.
If you do not use the GOT in a dark place, set the brightness adjustment mode to [Normal].

(a) Temporarily switching the brightness adjustment mode to the [Normal] mode in the utility screen
Not available to GT21 and GS21.
In the [Low] mode, touching the upper-left corner of the utility main menu screen for two seconds enters the [Normal] 
mode temporarily.
The brightness adjustment mode returns to the original mode at the following timing.

• When the screen is switched to a monitor screen
• When the setting of [Brightness adjust] or [Brightness adjustment] is changed in the utility

(The screen is displayed using the set value of [Brightness adjust] and [Brightness adjustment].)

Line No
.1
A 1254

B 348

A 1254

B 348

Brightness adjustment mode: [Normal]
Brightness adjustment: [32]

Brightness adjustment mode: [Low]
Brightness adjustment: [32]

Line No
.1
A 1254

B 348

A 1254

B 348

LightDark

1 32

LightDark

1 32

Touching for 
two seconds
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(4) POWER LED shutoff
Available to GT27, GT25, GT2105-Q, and GS25.
Even while the GOT is operating, the POWER LED can be off.

When you select [Turn off the POWER LED while GOT is in operation] in the POWER LED setting, the POWER LED only 
momentarily turns on at the GOT startup for checking operations.

■2 [Display Setting/Language Setting]

In [Display Setting/Language Setting], configure settings for the GOT display and the system language.
Select [Common] → [GOT Setup] → [Basic Setting] → [Display Setting/Language Setting] from the menu to display this 
window.

1) [Update the display setting/language setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set [Display Setting/Language Setting] items.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Title Display Time]
Set the title display time at the GOT startup.
The setting range is [0] to [60] second(s).
Regardless the set time, the title is always displayed at GOT startup.
(However, when [0] is set, the title is not displayed on GT21 and GS21.)
Therefore, the title display time may be longer than the set time.

3) [Time to start the screen saver function]
Set the time to the screen saver.
The setting range is [0] (Invalid) minutes to [60] minutes.

4) [Display the system alarm when the battery is low]
Not available to GT21 and GS21.
Select this item to display the system alarm when the battery voltage is low.

5) [Deactivate the screen saver with the motion sensor]
Available to GT27-X and GT27-S.

Line No
.1
A 1254

B 348

A 1254

B 348

Turning off the 

POWER LED 

even while 

the GOT is operating

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

7)
6)

5)

4)
3)

2)

8)

9)
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Cancels the screen saver mode when the human sensor detects the human motion.
After selecting this item, set the sensor detection level and the time to turn off the Human Sensor Detection signal.

6) [Brightness Adjustment Mode]
Select the brightness adjustment mode of the backlight.

• [Normal]
• [Low]

7) [Brightness Adjustment]
Set the intensity of the backlight.
The setting range is [1] to [32].
For GT23 with 16-level intensity adjustment, set this item with an even number.

8) [POWER LED Setting]
Available to GT27, GT25, GT2105-Q, and GS25.

9) [System Language]
Select the language to be used for the utility and the system message.
The following shows the items to be selected.

• [Japanese]
• [English]
• [Chinese (Simplified)]
• [Chinese (Traditional)] (Not available to GT21 and GS21)
• [Korean] (Not available to GT21 and GS21)

Item Description

[Motion Sensor Sensitivity] Set the human sensor detection level. The setting range is [0] to [10].

[Time to turn off the detection notice of the 
motion sensor]

Set the time from when the human sensor stops detecting the human motion to when the 
Human Sensor Detection signal turns off. The setting range is [10] to [3600] second(s).

Item Description

[Turn off the POWER LED while GOT is in 
operation] Turns off the POWER LED while the GOT is operating.
5. COMMON SETTING
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5.3.2 Setting the identification information to the GOT ([GOT ID No.])

➟■1 Specifications
■2 How to use the identification information
■3 Precautions
■4 [GOT ID No.]
■5 [GOT Setting List] dialog
■6 [GOT Setting] dialog

In [GOT ID No.], set the items, such as the GOT ID number, GOT name, and Ethernet interface.

■1 Specifications

(1) GOT identification information
Set the identification information for each GOT.
Up to 500 pieces of GOT identification information can be stored for a project.

■2 How to use the identification information

(1) Performing various operations in each GOT in one project
The GOT ID No. is stored in the GOT special register (GS3).
Using the GOT special register (GS3) allows object operations and script controls to have difference even when the same 
project is written to multiple GOTs.
Example) Writing the same project to three GOTs that have different GOT ID No.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Overview

GOT ID No. ID number to identify the GOT

GOT name Name to identify the GOT. Use as the identification information when obtaining the GOT 
list by the network.

GOT detailed description Detailed description for the GOT. Describe the supplemental information of the GOT.

Ethernet interface setting 
at the GOT side The communication interface setting at the GOT side for using the Ethernet connection.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Monitor device: D100
Offset device: GS3

Word lamp A

GOT ID No.: 1

Monitor D101

Word 
lamp A

GOT ID No.: 2

Monitor D102

Word 
lamp A

GOT ID No.: 3

Monitor D103

Word 
lamp A

Same project

D101: GOT No. 1 device
D102: GOT No. 2 device
D103: GOT No. 3 device
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(2) Switching the destination GOT for writing the package data
The Ethernet setting can be stored for each GOT ID No.
This enables the Ethernet interface setting to be switched when the destination GOT for writing the package data is 
switched.
Use this function to switch the communication setting in a system where multiple GOTs which use the same project exist.
If the communication setting switching is unnecessary, preparing multiple settings is unnecessary.

■3 Precautions

(1) Ethernet interface settings which are not included in the GOT identification information
The following settings are not included the GOT identification information.

• Number of retry
• Startup time
• Communication timeout time
• Send delay time

These settings cannot be changed by the GOT ID No. switching.

GOT ID No.: 1

Setting No. 1
IP: 192.168.3.1
Port No. 5012

GOT ID No.: 2

Setting No. 2
IP: 192.168.3.5
Port No. 5012

GOT ID No.: 3

Setting No. 3
IP: 192.168.3.7
Port No. 5012

Same project

Write with 
the setting 

No. 1 

Write with 
the setting 

No. 3 

Write with 
the setting 

No. 2

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [GOT ID No.]

In [GOT ID No.], set the GOT ID and the GOT name.
Select [Common] → [GOT Setup] → [Basic Setting] → [GOT ID No.] from the menu to display this window.

1) [Update the setting of GOT ID No.]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [GOT ID No.].

2) [GOT ID]
Set an ID number to identify the GOT.
The setting range is [1] to [32767].

3) [GOT Name]
Set a name to identify the GOT.
Up to 32 characters can be set.

4) [Detailed Description]
Set a description about the GOT.
Up to 512 characters can be set.
The line feed cannot be inserted into the description.

5) [GOT Setting List] button
Displays the [GOT Setting List] dialog.
In the [GOT Setting List] dialog, you can set the GOT information which have been previously registered by 
selecting from a list.

➟5.3.2 ■5 [GOT Setting List] dialog
6) [Restrict write from GT Designer3 of the older versions]

Disables the writing of package data, whose version is earlier than the version of the existing package data in the 
GOT.
When this item is enabled in the package data being executed on the GOT, the write restriction is applied to all 
drives of the GOT.
For precautions on writing package data to the GOT, refer to the following.

➟4.7 Precautions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)

5)

6)
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■5 [GOT Setting List] dialog

In the [GOT Setting List] dialog, the GOT identification information is displayed in a list.
Add, edit, and delete the GOT identification information by using the buttons on the dialog.
Select one from the GOT identification information list and click the [OK] button. The selected information is set to the 
[GOT ID No] window.

1) [Auto Acquisition] button
Acquires the GOT identification information automatically by Ethernet from the GOT on the same network as the 
personal computer.
You cannot acquire the GOT identification information of GT21 and GS21.

2) GOT identification information list
A list of the GOT identification information saved in the project.
Add, edit, and delete the GOT identification information by using the buttons on the window.

3) Buttons
Buttons for adding, editing, and deleting the GOT identification information.

Item Description

[Add] button
Adds new GOT individual information to the list. Enter the GOT individual information in the 
[GOT Setting] dialog.
➟5.3.2 ■6 [GOT Setting] dialog

[Edit] button
Edits the GOT identification information that is being selected in the GOT identification 
information list. Enter the GOT individual information in the [GOT Setting] dialog.
➟5.3.2 ■6 [GOT Setting] dialog

[Delete] button Deletes the GOT identification information that is being selected in the GOT setting list.

[Delete All] button Deletes all GOT identification information registered to the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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■6 [GOT Setting] dialog

In the [GOT Setting] dialog, edit the GOT identification information to be registered to the project.
Up to 256 GOT identification information settings can be stored.

1) [GOT ID]
Set an ID number to identify the GOT.
The setting range is [0] to [32767].
If 0 is set, the GOT ID is not used.

2) [GOT Name]
Set a name to identify the GOT.
Up to 32 characters can be set.

3) [Detailed Description]
Set a description about the GOT.
Up to 512 characters can be set.
The line feed cannot be inserted into the description.

4) [GOT Type]
Set the GOT type.
The following shows the setting range.

• [GT27**-X(1024x768)]
• [GT27**-S(800x600)]
• [GT27**-V(640x480)]
• [GT2705-V(640x480)]
• [GT25**-WX(1280x800)]
• [GT25**-W(800x480)]
• [GT25**-S(800x600)]
• [GT25**-V(640x480)]
• [GT2505-V(640x480)]
• [GT23**-V(640x480)]
• [GT2107-W(800x480)]
• [GT2105-Q (320x240)]
• [GT2104-R(480x272)]
• [GT2104-P(384x128)]
• [GT2103-P(320x128)]
• [GS25**-WX(1280x800)]
• [GS21**-W-N(800x480)]
• [GS21**-W(800x480)]

For the correspondence between the GOT types and GOT models, refer to the following.
➟1.1.2 Supported models

5) [GOT IP Address]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)
5)
6)

7)
8)
9)
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Set the IP address of the GOT.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

6) [I/F]
Set the interface for the GOT IP address.
The following shows the setting range.

7) [Peripheral S/W Communication Port No.]
Set the port No. used for the communication with GT Designer3.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

8) [Subnet Mask]
Set the subnet mask for the GOT.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

9) [Default Gateway]
Set the default gateway.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

Item Applicable GOT

[Ethernet Standard Port] GT27, GT25-S, GT25-V, GT25HS-V, GT23, GT21, GS21

[Ethernet Extended Port] GT27, GT25-S, GT25-V (excluding GT2505-V)

[Ethernet Standard Port 1]
GT25-W, GS25

[Ethernet Standard Port 2]

[Wireless LAN] GT27, GT25 (excluding GT2505-V and GT25HS-V), GS25
5. COMMON SETTING
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5.3.3 Configuring the settings for the touch operation on the GOT ([Operation 
Setting/Utility Call Key])

➟■1 Specifications
■2 [Operation Setting/Utility Call Key]

In [Operation Setting/Utility Call Key], configure settings for the GOT operations and the utility call key.

■1 Specifications

(1) Buzzer sound
A buzzer that sounds when the touch panel is touched.
Set no sound, the short sound, or the long sound as the buzzer sound.
In addition, the pitch of the buzzer can be changed. (Not available to GT21 and GS21)

(2) Key sensitivity
The touch detection speed of the touch panel (sensitivity) and the pressing pressure that is required to detect the touch 
operation (pressing pressure) can be changed in this setting.

(3) Utility call key
A key that calls the utility screen from the monitor screen.
Arrange the utility call key one of the four corners.
The utility key is not displayed on the screen.
To activate the utility call key, press the utility call key for a certain period.
Change the depression length for the utility call key activation in this setting.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

• Utility call key: Arranged on the upper left
• Depression length: Three seconds

Press and hold the upper left 
screen for three seconds to 
start the utility screen.
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■2 [Operation Setting/Utility Call Key]

In [Operation Setting/Utility Call Key], configure settings for the GOT operations and the utility call key.
Select [Common] → [GOT Setup] → [Basic Setting] → [Operation Setting/Utility Call Key] from the menu to display this 
window.

1) [Update the setting of operation/utility call key]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to configure the settings in [Operation Setting/Utility Call Key].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Buzzer]
Select the buzzer sound for the touch operations of objects and buttons.
The following shows the items to be selected.

• [None]
• [Short]
• [Long]

3) [Pitch]
Available to GT27, GT25, and GS25.
Set the pitch of the buzzer sound for the touch operations of objects and buttons.
The setting range is [1] (low tone) to [5] (high tone).

4) [Window Shifting Buzzer]
Select whether to sound or not the buzzer when moving the window screen.
The setting range is [ON] or [OFF].

5) [Key Sensitivity]
Set the speed for the utility call key to detect the touch operation of the touch panel.
The setting range is [1] (slow) to [8] (fast).

6) [Key Reaction]
Set the speed for the utility call key to detect the touch operation of the touch panel.
The setting range is [Standard] to [+120ms].

7) [Utility Call Key]
Select the position to arrange the key (utility call key) that calls the utility screen from the monitor screen.
The squares on the four corners indicate the positions where the utility call key can be arranged.
The black circle indicates the position of the utility call key.
Click one of the squares on the four corners to select the position of the utility call key.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

7)
5) 6)

4)
3)

2)

8)

1)

7)

4)

2)

8)

For GT27, GT25, GT23, GT SoftGOT2000, and GS25 For GT21 and GS21

Click any square of the corners to change the position of the black circle.
5. COMMON SETTING
5.3 Setting the Utility Function ([GOT Setup])

5 - 223



To disable the utility call key, click the black circle.

8) [Hold-down Time]
Set the depression length from you touch the utility call key to when the utility call key starts function.
The setting range is [0] to [5] second(s).

Click the black circle to deselect.
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5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB 
Host])

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.

➟■1 Specifications
■2 How to use a USB mouse, USB keyboard, USB barcode reader, and RFID controller
■3 Precautions
■4 [USB Host]

In [USB Host], select USB devices to be connected to the GOT.

■1 Specifications

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.

(1) Using a USB mouse
You can use a USB mouse by connecting to the USB interface (host) of the GOT directly.

(a) Applicable USB mouse
A two-button mouse is applicable.
A wheeled mouse and a mouse with more than two buttons can be used as a two-button mouse.
Wheels or special buttons on the mouse cannot be used.
Some GOT models do not support mice equipped with special function.

(b) Operation target
You can operate the objects, utility call key, window screens, and menu displayed on the GOT by using a USB mouse.
However, the following screens are not operable with a USB mouse.

• Touch panel calibration screen of the utility
• Touch panel check screen
• Dedicated screens for some extended functions

For the dedicated screens operable with a USB mouse, refer to the following.
➟GOT2000 Series User's Manual (Monitor)

(2) Using a USB keyboard
You can use a USB keyboard by connecting to the USB interface (host) of the GOT directly.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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USB mouse

USB interface (host)

USB keyboard

USB interface (host)
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(a) Applicable USB keyboard
The following keyboards can be used.

• Japanese 106 keyboard
• English 101 keyboard

Forward-compatible keyboards, including Japanese 109 keyboard or English 104 keyboard, are also available.
However, the keys which do not exist on Japanese 106 keyboard and English 101 keyboard are not available.
Some GOT models do not support keyboards equipped with special function such as the hub function.

(b) Characters that can be input from a USB keyboard
The GOT receives inputs from a USB keyboard as key codes.
The kana input with a USB keyboard is unavailable.
To enter hiragana or Pinyin characters and convert the entry into kanji or Simplified Chinese characters using Kana-Kanji/
Pinyin conversion, use the key window displayed on the GOT screen.
The following shows the key code corresponding to each key on a USB keyboard.

*1 The operation on the target object varies depending on the setting in the [Environmental Setting] window ([Key Windows]).
For the details, refer to the following.

➟5.2.4 ■4 [Key Window]
*2 Only available when Kana-Kanji/Pinyin conversion is enabled in GT2107-W for GT21.
*3 Only available when Kana-Kanji/Pinyin conversion is enabled in GS21-W-N for GS21.

Key on the USB keyboard Key code on the GOT Description

[Back Space] 0008h Delete the character on the cursor.

[Enter] *1 000Dh
Write the entry to a specified device, display the cursor on 
the target object, move the cursor to a different object, or 
close the key window.

[Esc] 001Bh Cancel the entry.

[-] (Hyphen) 002Dh Reverse the sign of the value (for the numerical input only).

[.] (Period) 002Eh Enter a decimal point (for the numerical input only).

[0] to [9] 0030h to 0039h
Enter a numeric character (for the numerical input only).

[A] to [F], [a] to [f] 0041h to 0046h

[0] to [9] 0030h to 0039h

Enter an ASCII or ASCII-compatible character (use 
prohibited).

[A] to [Z] 0041h to 005Ah

[a] to [z] 0061h to 007Ah

Symbol keys Character codes (ASCII)

[→], [←], [↑], [↓] 0080h, 0081h, 0082h, 0083h Moves the cursor

[Home] 0084h Convert the entry into kanji or Simplified Chinese characters 
(use prohibited).

[Page Up] 0085h Select the previous candidate.

[Page Down] 0086h Select the next candidate.

[End] 0087h Confirm the entry, or select the next group of hiragana 
characters to be converted to kanji characters.

[Delete] 0088h Delete all the entered characters.

[Ctrl] + [→], [Ctrl] + [←] *2*3 0090h, 0091h

Moves cursor within object.
Increase or decrease characters in a group of characters 
during conversion into kanji or Simplified Chinese 
characters.

[Ctrl] + [↑], [Ctrl] + [↓] FFFAh, FFFBh Increment, decrement
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(3) Using a USB barcode reader or RFID controller
You can use a USB barcode reader or RFID controller by directly connecting it to the USB interface (host) of the GOT.
A USB barcode reader or RFID controller acts as a USB keyboard and sends a key code to an input object, such as the 
text input or the numerical input, with the USB mouse/keyboard function.

The RFID function is not available for the device connected to the USB interface (host) of the GOT.
To use the RFID function, connect a device to the standard RS232 interface or the standard RS422/485 interface.

(a) Applicable USB barcode reader and RFID controller
USB barcode readers and RFID controllers must satisfy the following requirements.

• Equipped with a USB keyboard (HID) interface
• Compliant with USB standards

For the USB barcode readers and RFID controllers applicable to the USB mouse/keyboard function, refer to the following 
Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-
0160)

(b) Key codes that can be input from a USB barcode reader or RFID controller
The GOT receives inputs from a USB barcode reader or RFID controller as key codes.
Key codes that can be input are common to those for a USB keyboard.

➟5.3.4 ■1 (2) (b) Characters that can be input from a USB keyboard

(4) Using multiple USB devices together
You can use a USB mouse, USB keyboard, USB barcode reader, RFID controller, and data storage simultaneously via 
a USB hub connected to the USB interface (host) of the GOT.
Up to eight USB devices are usable. (Only one USB hub is usable, and the hub is not counted as a USB device.)
Up to four USB devices other than data storages are usable.
The number of usable data storages depends on the GOT model.

➟1.2.8 Drive configuration of the target GOT for data transfer

(a) Applicable USB hub
A USB version 2.0 compatible USB hub is available.

USB barcode reader

USB interface (host)

RFID controller

USB interface (host)

Data storage 
(USB memory)

USB keyboard USB mouse

USB hub

USB interface (host)
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■2 How to use a USB mouse, USB keyboard, USB barcode reader, and RFID controller

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.

(1) USB mouse
On the monitor screen and the utility screen, click the left button on the mouse to perform the touch operation.
Clicking the right button on the mouse is disabled.

On the remote personal computer operation screen, the USB mouse behaves in the same way as clicking on a personal 
computer screen.

(2) USB keyboard, USB barcode reader, and RFID controller
With a USB keyboard and USB barcode reader or RFID controller, you can input a key code to an object or a key window, 
move the cursor, delete text, and determine or cancel an input value.

• Numerical input, character string input
You can input numeric values, character strings, and move the cursor.

• Writing data to a controller device
You can write the read data to a controller device.

• Utility screen, system application screen
You can operate the utility and each system application.
In addition, you can input texts on the key window or dialogs.

• Security authentication screen
You can input the operator ID and a password on the authentication screen.

• Dialog window
You can operate each key on the dialog window.

The following keys and key codes are assigned to operation keys in the dialog window.

■3 Precautions

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.

(1) Touch operation during clicking
Do not touch the GOT screen while you are clicking the USB mouse.
The GOT recognizes the operation as 2-point press.

(2) Canceling the screen saver mode with a USB mouse
Do not cancel the screen saver mode by clicking the mouse.
Because you can cancel the screen saver mode by moving the mouse cursor, you may click unintentional position.

(3) USB keyboard setting
When setting [USB Host], set the USB keyboard type to be used in [Keyboard Type].
If a USB keyboard type that is not used is set, some characters cannot be input correctly.

➟5.3.4 ■4 [USB Host]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operation key Key on the USB keyboard Key code of USB barcode reader and RFID 
controller

[OK] key, [Confirm] key, or [Yes] key [Y] key, [y] key, or [Enter] key 59h (Y), 79h (y), or 0Dh (Enter)

[Cancel] key, [Stop] key or [No] key [N] key, [n] key, or [Esc] key 4Eh (N), 6Eh (n), or 1Bh (Esc)

[Apply] key or [No to All] key [A] key or [a] key 41h (A), or 61h (a)

[No to All] key [S] key or [s] key 53h (S), or 73h (s)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [USB Host]

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.
In [USB Host], set USB devices to be connected to the GOT.
Select [Common] → [GOT Setup] → [Basic Setting] → [USB Host] from the menu to display this window.

1) [Update the USB host setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [USB Host].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Use USB mouse]
Enables a USB mouse connected to the USB interface (host) of the GOT.

3) [Move the mouse cursor to the touched position on the GOT screen]
Select this item to move the mouse cursor to a position you touch.

4) [Use USB keyboard/USB bar code]
Enables a USB keyboard, USB barcode reader, or RFID controller connected to the USB interface (host) of the 
GOT.

5) [Keyboard Type]
Select the type of a USB keyboard to be used.
When using a USB barcode reader or RFID controller, select the Japanese 106 keyboard or the English 101 key 
board to input a key code.
The following shows the items to be selected.

• [106 keys (Japanese)]
Uses the Japanese 106 keyboard.
When a USB barcode reader or RFID controller is used, an input is recognized as a key code of the Japanese 
106 keyboard.

• [101 keys (English)]
Uses the English 101 keyboard.
When a USB barcode reader or RFID controller is used, an input is recognized as a key code of the English 
101 keyboard.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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5.3.5 Setting the GOT time setting method ([Time Setting])

➟■1 Specifications
■2 Precautions
■3 [Time Setting]

In [Time Setting], the setting method for the clock data between the GOT and the controller is set.

GT SoftGOT2000 clock
GT SoftGOT2000 uses the clock of the personal computer.
Therefore, the time on the personal computer is changed when the time setting function is performed.

■1 Specifications

(1) Clock synchronization method
The following shows the clock synchronization method on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Clock synchronization 
method Description Supported 

models

Time setting function

Acquire the clock data of the controller or the SNTP server and change the clock data of the GOT.
GT21, GT SoftGOT2000, and GS21 cannot acquire the clock data from the SNTP server.

When the GOT is powered on, set the clock data of the GOT to that of the controller or the SNTP server.
Since the GOT does not have to hold the clock data while the GOT is powered off, no battery is 
required.
(If the GOT needs to hold the clock data at startup, install a battery in the GOT.)
To set the controller clock data of the controller, refer to the manual of the controller you use.

Time notification function

Not available to GT2103-P.
Notify the clock data of the GOT to the controller to change that of the controller.

At the timing of the trigger, set the clock data of the controller to that of the GOT.
Since the GOT must hold the clock data while the GOT is powered off, a battery is required.
Set the clock data of the GOT in the utility.

Clock data

2013/4/1
12:45:07

2013/4/1
12:45:07

Clock data

2013/4/1
12:45:07

2013/4/1
12:45:07

SNTP server GOT

PLC GOT

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Clock data

2013/4/1
12:45:07

2013/4/1
12:45:07

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(2) Controllers available for the time setting function and the time notification function

GOTs other than GT SoftGOT2000 perform the time setting function or the time notification function to the controllers 
equipped with a clock.
For controllers equipped with a clock, refer to the following.

➟GOT2000 Series Connection Manual for a controller used
For the controllers subjected to the time setting function and the time notification function by GT SoftGOT2000, refer to 
the following.

➟GT SoftGOT2000 Version1 Operating Manual

(3) SNTP server

The operating environment for the SNTP server depends on the OS used.
The following shows the correspondence table.

*1 The OS does not support the Server Core installation.
Fully install the OS.

*2 The standard user or administrator account is required.

Using the time setting 
function and the time 
notification function 
together

Not available to GT2103-P.
Acquire the clock data of the controller or the SNTP server by the time setting function. Then change 
the clock data of other controllers by the time notification function.
GT21 and GT SoftGOT2000 cannot acquire the clock data from the SNTP server.

Clock synchronization 
method Description Supported 

models

Time setting

2013/4/1
12:45:07

2013/4/1
12:45:07

SNTP server GOT

Time

2013/4/1
12:45:07

function
notification

function

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Model Personal computer that Windows runs on.

OS(English version)

• Microsoft Windows Server 2008 R2*1*2

• Microsoft Windows Server 2008*1*2

• Microsoft Windows Server 2003 x64 Edition*3*4

• Microsoft Windows Server 2003*3*4

• Microsoft Windows 2000 Server Service Pack2 or later*3

• Microsoft Windows 7 Ultimate (32 bit, 64 bit)*2*4*5

• Microsoft Windows 7 Enterprise (32 bit, 64 bit)*2*4*5

• Microsoft Windows 7 Professional (32 bit, 64 bit)*2*4*5

• Microsoft Windows Vista Ultimate (32 bit) Service Pack1 or later*2*4

• Microsoft Windows Vista Enterprise (32 bit) Service Pack1 or later*2*4

• Microsoft Windows Vista Business (32 bit) Service Pack1 or later*2*4

• Microsoft Windows XP Professional (32 bit) Service Pack2 or later*3*4

• Microsoft Windows 2000 Professional Service Pack2 or later*3

CPU Use the CPU which the above OSs run on.

Memory Use the memory which the above OSs run on.

Display Use the hardware compatible with the above OSs.

Hard disk space Reserve a free space which the above OSs run on. (If Windows Server 2008 R2, Windows Server 2008, 
Windows 7, or Windows Vista is used, 15GB or more)

Other hardware
Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD drive
• For execution: mouse, keyboard

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*3 For installation, the administrator authority is required.
*4 The following functions are not supported.

• Application start in Windows compatibility mode
• Fast user switching
• Changing your desktop themes (fonts)
• Remote desktop
• DPI setting other than the normal size

*5 Windows XP Mode is not supported.

(4) Local time

Set the local time to enable the time setting among the countries or areas with a time difference.
Specify the local time with a time difference from the Greenwich mean time.
The summer time cannot be set.

➟5.3.5 ■3 (3) [Local Time] tab
Example) Time setting when Greenwich Mean Time is 2023/04/05 0:00

(5) Changing the current time with the GOT special register (GS)

The GOT always writes the clock data to the GOT special register (GS).
The clock data of the GOT can be changed with a numerical input and others by using the clock data stored in the GOT 
special register (GS) and the Time Change signal.

➟12.1.3 GOT special register (GS)

(a) Read device
The following devices are not available to GT SoftGOT2000.

GOT location Local time setting Time

Country A GMT-5:00 2023/04/04 19:00

Country B GMT-1:00 2023/04/04 23:00

Country C GMT+5:00 2023/04/05 05:00

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item Bit number Description

Time Change 
signal GS512 .b0

A trigger device to change the current time Changes the clock data 
of the GOT to the data of the change time (GS513 to GS516) when 
the bit is turned on.

Change time

GS513
.b8 to .b15 Two lower digits of year (data type: BCD)

.b0 to .b7 Month (data type: BCD)

GS514
.b8 to .b15 Date (data type: BCD)

.b0 to .b7 Time (data type: BCD)

GS515
.b8 to .b15 Minute (data type: BCD)

.b0 to .b7 Second (data type: BCD)

GS516
.b8 to .b15 Use prohibited

.b0 to .b7 Day (0: Sunday, 1: Monday, 2: Tuesday, 3: Wednesday, 4: 
Thursday, 5: Friday, 6: Saturday)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Write device

■2 Precautions

(1) Time setting function and time notification function for the same controller
Do not configure the settings to execute both the time setting function and the time notification function for the same 
controller.
Doing so may delay the clock data.

(2) Ethernet settings to acquire clock data from the SNTP server
To acquire clock data from the SNTP server, set an Ethernet interface of the GOT in the [I/F Communication Setting] 
dialog or other setting dialogs.
The clock data is acquired via Ethernet.
If no Ethernet interface is usable, the clock data cannot be acquired.

➟5.7.2 How to use the I/F communication setting

(3) Controller action after the time notification function is performed
After the time notification function is performed, the target controller acts differently depending on its system configuration 
(such as the multiple CPU system). For example, the target controller CPU may notify the obtained time data to another 
CPU.
For the controller action, refer to the manual of the controller used.

(4) Time setting function and time notification function for network-connected controllers
When the GOT and controllers are connected using any of the following connection types, only the controller of the host 
station or master station (specified control station) is targeted for the time setting function and the time notification 
function.

*1 When this station is disconnected, the GOT cannot perform the time setting function or the time notification function on the 
station.

*2 After the time distribution from the master station, the time is set in the GOT.
For the time distribution from the master station, refer to the following.
➟MELSEC iQ-R CC-Link IE TSN User's Manual (Application)

*3 The time notification function is not supported.

(5) Personal computer time zone when using GT SoftGOT2000
Set the same time zone for the personal computer and controller.
Otherwise, a time difference occurs.

Function Setting item Bit number Description

Current time

GS650
.b8 to .b15 Two lower digits of year (data type: BCD)

.b0 to .b7 Month (data type: BCD)

GS651
.b8 to .b15 Date (data type: BCD)

.b0 to .b7 Time (data type: BCD)

GS652
.b8 to .b15 Minute (data type: BCD)

.b0 to .b7 Second (data type: BCD)

GS653
.b8 to .b15 Use prohibited

.b0 to .b7 Day (0: Sunday, 1: Monday, 2: Tuesday, 3: Wednesday, 4: 
Thursday, 5: Friday, 6: Saturday)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Connection type Target of time setting function and time notification function

Ethernet connection Host station

MELSECNET/H connection

Master station (specified control station) *1

MELSECNET/10 connection

CC-Link IE TSN connection *2*3

CC-Link IE Controller Network connection

CC-Link IE Field Network connection
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(6) Time setting function on GT SoftGOT2000
Under the following conditions, the time setting function cannot be used on GT SoftGOT2000.
If the function is used under the following conditions, a time difference occurs.

• The user who has started GT SoftGOT2000 does not have the authority to change the system time.
• The clock of the personal computer is synchronized with an Internet time server.
• Software that periodically adjusts the clock of the personal computer is used.

■3 [Time Setting]

In [Time Setting], the setting method for the clock data of the GOT is set.
Select [Common] → [GOT Setup] → [Basic Setting] → [Time Setting] from the menu to display this window.

1) [Update the time setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [Time Setting].
When a project is read from the GOT, the setting changed in the utility is reflected.

➟5.3.5 ■3 (1) [Adjust] tab
　 5.3.5 ■3 (2) [Broadcast] tab
　 5.3.5 ■3 (3) [Local Time] tab

(1) [Adjust] tab

1) [Adjust the clock]
Select this item to use the time setting function.
After selecting this item, set how to acquire the clock data.

2) [Mode]
Not available to GT21, GT SoftGOT2000, and GS21.
Set the destination device of the clock data and how to acquire the clock data.

• [Get time information from external unit]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4)

6)

4)
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Select this item to acquire the clock data from a controller, such as a PLC.
After selecting this item, set [Reference CH No.] and [Trigger Type].

• [Get time information from SNTP server]
Select this item to acquire the clock data from the SNTP server.
After selecting this item, set [IP Address] and [Trigger Type] of the destination.

3) [Reference CH No.]
For GT27, GT25, GT23, and GS25, this item is settable when [Mode] is set to [Get time information from external 
unit].
Set the channel No. to connect the device from which the clock data is acquired.
The following shows the items to be selected.

• GT27, GT25, GT SoftGOT2000, GS25: [1] to [4]
• GT23, GT21, and GS21: [1] and [2]

4) [IP Address]
Not available to GT21, GT SoftGOT2000, and GS21.
This item is settable when [Mode] is set to [Get time information from SNTP server].
Set the IP address of the SNTP server from which the clock data is acquired.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

5) [Trigger Type]
Set the trigger to acquire the clock data.

• [Rise]
Acquires the clock data at the rise of the trigger device.
After selecting this item, set the trigger device.

• [Fall]
Acquires the clock data at the fall of the trigger device.
After selecting this item, set the trigger device.

• [Sampling]
Set the cycle to acquire the clock data.
The setting range is [1] to [1440] minutes.

6) [Specify the time zone of target unit]
Not available to GT SoftGOT2000.
Select this item to set the time zone of the destination device of the clock data.
The setting range is [GMT-12:00] to [GMT+13:00], or [Custom].
When [Custom] is selected, the time difference with GMT can be set by 15 minutes.

(2) [Broadcast] tab

Not available to GT2103-P.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Broadcast the clock data]
Select this item to use the time notification function.
After selecting this item, set how to notify the clock data.

2) [Broadcast CH No.]
Set the channel No. to connect the destination device of the clock data.
The following shows the items to be selected.

• GT27, GT25, GT SoftGOT2000, GS25: [CH 1] to [CH 4]
• GT23, GT21: [CH1] and [CH2]

3) [Trigger Type]
Set the trigger to notify the clock data.

• [Rise]
Notifies the clock data at the rise of the trigger device.
After selecting this item, set the trigger device.

• [Fall]
Notifies the clock data at the fall of the trigger device.
After selecting this item, set the trigger device.

• [Sampling]
Set the cycle to notify the clock data.
The setting range is [1] to [1440] minutes.

4) [Specify the time zone of target unit]
Not available to GT21 and GT SoftGOT2000.
Select this item to set the time zone of the destination device of the clock data.
The setting range is [GMT-12:00] to [GMT+13:00], or [Custom].
When [Custom] is selected, the time difference with GMT can be set by 15 minutes.

(3) [Local Time] tab

1) [Specify time zone]
Select this item to set the time zone.
The setting range is [GMT-12:00] to [GMT+13:00], or [Custom].
When [Custom] is selected, the time difference with GMT can be set by 15 minutes.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.6 Setting the FA transparent function ([Transparent Mode Setting])

➟■1 [Transparent Mode Setting]
In [Transparent Mode Setting], set a channel number used for the FA transparent function when using the multi-channel 
function.
For the details of the FA transparent function, refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

■1 [Transparent Mode Setting]

In [Transparent Mode Setting], set a channel number used for the FA transparent function when using the multi-channel 
function.
Select [Common] → [GOT Setup] → [Basic Setting] → [Transparent Mode Setting] from the menu to display this window.

1) [Update the transparent mode setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [Transparent Mode Setting].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Controller CH No.]
Select a channel number used for the FA transparent function.
The following shows the items to be selected.

• [CH1] to [CH4] (GT27, GT25, and GS25)
• [CH1] and [CH2] (GT23, GT21, and GS21)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.7 Configuring the settings of the GOT internal device monitor ([GOT Internal 
Device Monitor])

➟■1 [GOT Internal Device Monitor]
In [GOT Internal Device Monitor], configure the settings of the GOT internal device monitor.
For the details on the GOT internal device monitor of the GOT diagnostics function, refer to the following.

➟11.14 Checking the Causes and Corrective Actions for an Error in the GOT (GOT Diagnostics)

■1 [GOT Internal Device Monitor]

In [GOT Internal Device Monitor], configure the settings of the GOT internal device monitor.
Select [Common] → [GOT Setup] → [Basic Setting] → [GOT Internal Device Monitor] from the menu to display the following 
window.

1) [Update the GOT internal device monitor setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to enable the setting items in [GOT Internal Device Monitor].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Use GOT internal device monitor in the GOT diagnostics function]
Allows GT Designer3 to monitor the GOT internal devices when the GOT diagnostics runs.

3) [Allow GOT internal devices to be changed]
Allows GT Designer3 to change the values of the GOT internal devices when the GOT diagnostics runs.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.8 Configuring the settings of the SoftGOT-GOT link function ([SoftGOT-GOT 
Link])

➟■1 [SoftGOT-GOT Link]

In [SoftGOT-GOT Link], configure the settings for the authorization of the SoftGOT-GOT link function and others.
For the details of the SoftGOT-GOT link function, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

■1 [SoftGOT-GOT Link]

In [SoftGOT-GOT Link], configure the settings for the authorization of the SoftGOT-GOT link function and others.
Select [Common] → [GOT Setup] → [Advanced Setting] → [SoftGOT-GOT Link] from the menu to display this window.

1) [Update the SoftGOT-GOT link function setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [SoftGOT-GOT Link].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Time for GOT to automatically acquire operational authority]
Set the time from when GT SoftGOT2000 is operated after GT SoftGOT2000 obtains the authorization until when 
the GOT automatically obtains the authorization.
The setting range is [0] (Invalid) seconds to [3600] seconds.

3) [Guaranteed time of operational authority after the last operation]
Set the time to retain the authorization after GT SoftGOT2000 or the GOT obtains the authorization and then GT 
SoftGOT2000 or the GOT is operated.
The setting range is [0] (Invalid) seconds to [3600] seconds.
This setting is disabled when GS447.b1 is turned on.
When [Use GOT network interaction function] is selected in the [GOT Network Interaction] dialog, the authorization 
guarantee time set for the GOT network interaction function is prioritized.

4) [Display the operational state in a pop-up window]
The information of GT SoftGOT2000 or the GOT with the authorization is popped up on GT SoftGOT2000 or the 
GOT without the authorization.

5) [GOT Network Interaction] button
Displays the [GOT Network Interaction] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.9 Configuring the settings of the VNC server function ([VNC Server])

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

➟■1 [VNC Server]
In [VNC Server], configure the settings for the authorization of the VNC server function.
For the details of the VNC server function, refer to the following.

➟10.5 Viewing the GOT from a Personal Computer (VNC Server Function)

■1 [VNC Server]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
In [VNC Server], configure the settings for the authorization of the VNC server function.
Select [Common] → [GOT Setup] → [Advanced Setting] → [VNC Server] from the menu to display this window.

1) [Update the VNC server function setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [VNC Server].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [VNC Server] button
Set how to connect the VNC server.
Click this button to display the [VNC Server] dialog.

➟10.5.4 [VNC Server] dialog
3) [Guaranteed time of operational authority after the last operation]

Set the time to retain the authorization after the VNC server (GOT) or the VNC client (personal computer) obtains 
the authorization and then the VNC server (GOT) or the VNC client (personal computer) is operated.
The setting range is [0] (Invalid) seconds to [3600] seconds.
This setting is disabled when GS1792.b8 is turned on.
When [Use GOT network interaction function] is selected in the [GOT Network Interaction] dialog, the authorization 
guarantee time set for the GOT network interaction function is prioritized.
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5.3.10 Configuring the settings of the sequence program monitor ([Sequence 
Program Monitor])

➟■1 [Sequence Program Monitor]

In [Sequence Program Monitor], configure the settings for reading sequence programs and displaying comments on the 
sequence program monitor.
For the details of the sequence program monitor, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

■1 [Sequence Program Monitor]

In [Sequence Program Monitor], configure the settings for reading sequence programs and displaying comments on the 
sequence program monitor.
Select [Common] → [GOT Setup] → [Advanced Setting] → [Sequence Program Monitor] from the menu to display this 
window.

1) [Update the sequence program monitor setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [Sequence Program Monitor].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Data Save Location]
Select a destination to save the data of the sequence program monitor.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

3) [Priority Comment]
Select the priority comment when a common comment and each program comment are set for the same device in 
the sequence program.
The following shows the items to be selected.

• [Common Comment]
• [Comment by program]

4) [Automatically read out a sequence program]
Automatically reads a sequence program from the controller at the sequence program monitor startup.

5) [Use sequence program monitor in MELSEC iQ-R/MELSEC iQ-L series]
Enables the sequence program monitor (iQ-R/iQ-L ladder).
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Select this item to incorporate a system application (extended function) of [Sequence Program Monitor (iQ-R/iQ-L 
Ladder)] into the package data.

6) [Use the ladder edit function]
Enables the ladder edit function in the sequence program monitor (iQ-R/iQ-L ladder).

7) [Use sequence program monitor in MELSEC iQ-F series]
Allows the use of the sequence program monitor (iQ-F ladder).
Select this item to incorporate a system application (extended function) of [Sequence Program Monitor (iQ-F 
Ladder)] into the package data.
The ladder edit function is also usable.

8) [Use sequence program monitor in MELSEC Q/MELSEC L series]
Allows the use of the sequence program monitor (Ladder).
Select this item to incorporate a system application (extended function) of [Sequence Program Monitor (Ladder)] 
into the package data.
The ladder edit function is also usable.
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5.3.11 Configuring the settings of the backup/restoration function ([Backup/Restore])

➟■1 [Backup/Restoration]
■2 [Trigger Setting] dialog
■3 [Device List] dialog (trigger device, process notification device)
■4 Relevant settings

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
In [Backup/Restoration], configure the settings of the destination to save the backup data or the trigger backup setting.
For the details of the backup/restoration function, refer to the following.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
➟GOT2000 Series User's Manual (Monitor)

• For GT21 and GS21
➟GOT2000 Series User's Manual (Utility)

GOT SIMPLE series user's manuals

■1 [Backup/Restoration]

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
In [Backup/Restoration], configure the settings of the destination to save the backup data or the trigger backup setting.
Select [Common] → [GOT Setup] → [Advanced Setting] → [Backup/Restoration] from the menu to display this window.

1) [Update the backup/restore save setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item in [Backup/Restoration].
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Destination for Backup Setting]
Select a destination to save the backup setting.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]
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For the available drives by GOT model, refer to the following.
➟1.2.8Drive configuration of the target GOT for data transfer

3) [Destination for Backup Data]
Select a destination to save the backup data.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8Drive configuration of the target GOT for data transfer

4) [Maximum Number of Backup Data]
Not available to GT21 and GS21.
Select the maximum number of saved backup data.

• [No limit]
Saves the data to the drive selected in [Destination for Backup Data] as much as possible.

• [Number]
Saves the data up to the set number of saved backup data.
After selecting this item, set the maximum number of saved backup data.
The setting range is [1] to [50].

5) [Set CPU No. in GOT]
Not available to GT21 and GS21.
Select this item to set the CPU No. of the PLC which executes a backup.

6) [Retain the file register of PLC at the time of restoring]
Not available to GT21 and GS21.
Retains the file registers of a PLC at restoration.

7) [Perform a backup with a trigger]
Not available to GT21 and GS21.
Select this item to execute a backup by a trigger you set.
After selecting this item, set the backup trigger from the list of backup triggers.

8) List of backup trigger settings
Not available to GT21 and GS21.
Displays the backup trigger settings in a list.

• [CH No.]: Channel number for which the backup trigger setting is used
• [Type]: Trigger type
• [Detail]: Details of the setting
• [Process Notification]: Backup process notification device
• [Data Check]: Indicates if the data check after the backup is performed or not.

9) Operation button of backup trigger settings
Not available to GT21 and GS21.
The following buttons edit the list of backup trigger settings.

10) [Use Backup Error Notification]
Not available to GT21 and GS21.
Stores the channel number of the backup trigger in the notification device if an error occurs during the backup.
After selecting this item, set [Notification Device].
A word device can be used for the notification device.

11) [Register a device to be used for trigger backup]
Not available to GT21 and GS21.
Register the devices used for the trigger backup.

Item Description

[Edit] button
Displays the [Trigger Setting] dialog.
➟5.3.11 ■2 [Trigger Setting] dialog

[Clear] button Deletes the selected backup trigger setting.

[Clear All] button Deletes all the backup trigger settings.
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Up to 10 devices can be registered for each trigger device and process notification device.

■2 [Trigger Setting] dialog

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

1) [CH No.]
Channel number for which the backup trigger setting is used.

2) [Trigger Type]
Select a trigger type to execute the backup.
The following shows the items to be selected.

• [Rise]
• [Time]

3) [Trigger Device]
Select a trigger device from the devices set in the [Device List (Trigger Device)] dialog.
This item is displayed when [Rise] is selected in [Trigger Type].

4) [Time Setting]
Set the time and day to take the backup.
This item is displayed when [Time] is selected in [Trigger Type].

5) [Set Process Notification Device]
Select a device to notify a backup is in process.
Select a process notification device from the devices set in the [Device List (Process Notification Device)] dialog.

6) [Check data in the controller and the GOT]
Select this item to check the data in the controller and backup data in the GOT when a backup is executed.

Item Description

[Trigger Device] button
Displays the device list (trigger device) dialog. Register bit devices used for the trigger 
device.
➟5.3.11 ■3 [Device List] dialog (trigger device, process notification device)

[Process Notification Device] button
Displays the device list (process notification device) dialog. Register bit devices used for 
the process notification device.
➟5.3.11 ■3 [Device List] dialog (trigger device, process notification device)

Item Description

[Trigger Device] button
Displays the device list (trigger device) dialog. Register bit devices used for the trigger 
device.
➟5.3.11 ■3 [Device List] dialog (trigger device, process notification device)

Item Description

[Daily] button Selects all the days.

Item Description

[Edit] button
Displays the [Device List (Process Notification Device)] dialog. Register bit devices used 
for the process notification device.
➟5.3.11 ■3 [Device List] dialog (trigger device, process notification device)
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7) [Target File Register for Difference Check]
Select this item to check if the file register is changed when a backup is executed.
If the file register is changed as a result of the check, a backup is executed.
This item can be selected when [Check data in the controller and the GOT] is selected.

■3 [Device List] dialog (trigger device, process notification device)

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

1) Device list
Lists the trigger devices or process notification devices.
Click the [Device] field to display the [...] button.
Set the trigger device or process notification device.
The bit device is available.

2) [Clear] button
Deletes the selected device.

3) [Clear All] button
Deletes all the devices.

■4 Relevant settings

Set the relevant settings other than the specific settings for the backup/restoration function as required.
The following shows the functions that are available by the relevant settings.

(1) GOT internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3)
2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Executing the GOT data package acquisition when the trigger backup is complete GS522.b6
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5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

Not available to GT2505-V and GT25HS-V.
➟■1 Specifications
■2 How to use the wireless LAN (GOT operation mode: station)
■3 How to use the wireless LAN (GOT operation mode: access point)
■4 Precautions
■5 [Wireless LAN Setting]
■6 Relevant settings

In [Wireless LAN Setting], configure the wireless LAN function setting.
On a wireless LAN, the GOT operates as a station or wireless LAN access point to communicate with other devices such 
as a personal computer.

■1 Specifications

Not available to GT2505-V and GT25HS-V.

(1) Operation mode and system configuration
The following explains the operation mode of the wireless LAN function.
For the details of the system configuration of a wireless LAN connection, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputer, MODBUS/Fieldbus Products, Peripherals) for GT 
Works3 Version1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) When [Operation Mode] is set to [Station]
The GOT operates as a station to communicate with other devices via a wireless LAN access point.
The following shows the access range when the wireless LAN connection is used.

○ : Accessible, ×: Inaccessible, -: Outside the wireless LAN range

*1 Communication is available using the server/client function

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Access source
Access destination

1) 2) 3) 4) 5) 6) 7) 8)

1) Personal computer - - - ○ ○ - ×*1 ×*1

2) Controller - - - × ×*1 - × ×*1

3) GOT - - - ×*1 ○ - ×*1 ×*1

4) Controller ○ × ×*1 - - ○ - -

5) GOT (Station) ○ ×*1 ○ - - ○ - -

6) Personal computer or tablet (Station) - - - ○ ○ - ×*1 ×*1

7) Controller ×*1 × ×*1 - - ×*1 - -

8) GOT ×*1 ×*1 ×*1 - - ×*1 - -

5) GOT (Station)

6) Personal computer

1) Personal computer 2) Controller 3) GOT

4) Controller

8) GOT7) Controller

Ethernet

Ethernet

Network other

access point or tablet (Station)
Wireless LAN

than Ethernet connection
Wireless LAN

connection
Wireless LAN
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(b) When [Operation Mode] is set to [Access Point]
The GOT operates as a wireless LAN access point to communicate with other devices such as a tablet.
Up to five stations are connectable to one GOT (wireless LAN access point).
The following shows the access range when the wireless LAN connection is used.

○ : Accessible, ×: Inaccessible, -: Outside the wireless LAN range

*1 Communication is available using the server/client function

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Access source
Access destination

1) 2) 3) 4) 5) 6) 7) 8) 9) 10) 11)

1) Personal computer - - - - × × × × × × ×

2) GOT (Wireless LAN access 
point) - - - - ○ ○ ×*1 ×*1 × × ○

3) Controller - - - - × × × × × × ×

4) Controller - - - - × × × × × × ×

5) Personal computer or tablet 
(Station) × ○ ○ ×*1 - ○ ○ × × ○ ○

6) GOT (Station) × ○ ×*1 ×*1 ○ - - - - × ○

7) Controller × × × × × - - - - × ×

8) Controller × × × × × - - - - × ×

9) Personal computer × × × × × - - - - × ×

10) Controller × × × × ○ × × × × - -

11) Personal computer × ○ ○ ×*1 ○ ○ ○ ×*1 × - -

1) Personal computer

3) Controller

Ethernet

5) Personal computer

10) Controller8) Controller 11) Personal computer

EthernetEthernet

Station

or tablet (Station)
4) Controller2) GOT

(Wireless LAN access point)

7) Controller6) GOT (Station)

9) Personal computer

Network other
than Ethernet

Network other
than Ethernet

connection
Wireless LAN

connection
Wireless LAN
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(2) Required hardware, BootOS, and system application (extended function)

For information on how to install the BootOS and system application (extended function) on the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT

(3) Available GOT functions when the wireless LAN function is used
When the wireless LAN function is used, the following functions are available regardless of the operation mode.

*1 No controllers are listed in the connection target list display area of the target selection screen.
Directly enter the IP address of an applicable controller in [IP address].

Operation mode Required hardware, BootOS, and system application (extended function)

[Station]

Hardware

• Wireless LAN communication unit (GT25-WLAN)
• Wireless LAN access point (commercial product)
For the wireless LAN access points validated for the wireless LAN connection, 
refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE 

Series (for Overseas) (GOT-A-0160)

BootOS Version C or later

System application (extended 
function) [Wireless LAN]

[Access Point]

Hardware Wireless LAN communication unit (GT25-WLAN)

BootOS Version C or later

System application (extended 
function) [Wireless LAN]

Function Reference

Time setting function (Acquiring time-of-day information from the SNTP server) ➟5.3.5 Setting the GOT time setting method ([Time Setting])

FA transparent function ➟GOT2000 Series Connection Manual (Mitsubishi Products) for 
GT Works3 Version1

Remote personal computer operation (Ethernet) ➟10.3 Operating a Personal Computer by Using the GOT 
(Remote Personal Computer Operation (Ethernet))

VNC Server function ➟10.5 Viewing the GOT from a Personal Computer (VNC Server 
Function)

Multimedia function (Sending a video file to a personal computer) ➟10.8 Recording or Playing Images Taken by a Video Camera on 
the GOT (Multimedia Function)

Gateway function

Server/Client function ➟10.13 Monitoring a Controller through a GOT (Server/Client 
Function)

Mail send function ➟10.15 Sending a Mail from the GOT (Mail Send Function)

FTP server function ➟10.16 Transferring a File between the GOT and Peripheral 
Device (FTP Server Function)

File transfer function (FTP transfer) ➟10.17 Transferring a File between the GOT and Peripheral 
Device (File Transfer Function (FTP Transfer))

SoftGOT-GOT link function ➟GT SoftGOT2000 Version1 Operating Manual

MES interface function ➟GOT2000 Series MES Interface Function Manual for GT 
Works3 Version1

Log viewer function*1 ➟GOT2000 Series User's Manual (Monitor)

GOT Mobile function ➟10.19 Monitoring a Controller from Tablets or Other Clients 
(GOT Mobile Function)
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■2 How to use the wireless LAN (GOT operation mode: station)

Not available to GT2505-V and GT25HS-V.
Set the GOT as a station to communicate with a personal computer via a wireless LAN access point.
When the FA transparent function is used, a communication between the PLC and the personal computer can also be 
used.
When the server/client function is used, a controller device can also be monitored via a gateway device.

(1) Setting procedure
Before configuring the settings, check the SSID, security authentication method, and WEP key or passphrase of the 
wireless LAN access point to be used.
For the check method, refer to the following.

➟Manual of the wireless LAN access point used
Configure the settings on GT Designer3 in the following procedure.

Step 1 Select [Common] → [GOT Setup] → [Advanced Setting] → [Wireless LAN Setting] from the menu to display 
the [GOT Setup] window ([Wireless LAN Setting]).

Step 2 Set the following items, and click the [OK] button.
• Select [Update the wireless LAN setting].
• Select [Station] for [Operation Mode].
• Set [Destination Access Point Setting].

➟5.3.12 ■5 [Wireless LAN Setting]
Step 3 Select [Common] → [GOT Ethernet Setting] → [GOT IP Address Setting] from the menu to display the [GOT 

Ethernet Setting] window ([GOT IP Address Setting]).
Step 4 In the [Wireless LAN] tab, set the following items.

• Select [Update GOT wireless LAN I/F setting].
• Set [GOT IP Address].
• Set [Subnet Mask].
• Select [Enable wireless LAN I/F].

Step 5 Click the [Driver Setting] button to display the [Detail Setting] dialog.
Step 6 Set the following items, and click the [OK] button.

• Set [GOT Net No.].
• Set [GOT Station].

Step 7 In the [GOT Ethernet Setting] window, click the [OK] button.
Step 8 Select [Common] → [GOT Ethernet Setting] → [GOT Ethernet Common Setting] from the menu to display 

the [GOT Ethernet Setting] window ([GOT Ethernet Common Setting]).
Step 9 Set the following items, and click the [OK] button.

• Set [Default Gateway].
• Set [Peripheral S/W Communication Port No.].
• Set [Transparent Port No.].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT

Ethernet

Wireless LAN access point

Personal computer

Personal computerController

Communication by using the FA transparent function 
via a wireless LAN access point
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Communication via a wireless LAN access point

Network other 
than Ethernet
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■3 How to use the wireless LAN (GOT operation mode: access point)

Not available to GT2505-V and GT25HS-V.
Set the GOT as a wireless LAN access point to communicate with stations (such as a GOT, personal computer, and 
tablet) on a wireless LAN.
When the FA transparent function is used, a communication between the PLC and the personal computer can also be 
used.
When the server/client function is used, a controller device can also be monitored via a gateway device.

(1) Setting procedure
Configure the settings on GT Designer3 in the following procedure.

Step 1 Select [Common] → [GOT Setup] → [Advanced Setting] → [Wireless LAN Setting] from the menu to display 
the [GOT Setup] window ([Wireless LAN Setting]).

Step 2 Set the following items, and click the [OK] button.
• Select [Update the wireless LAN setting].
• Select [Access Point] for [Operation Mode].
• Set [Access Point Setting].

➟5.3.12 ■5 [Wireless LAN Setting]
Step 3 Select [Common] → [GOT Ethernet Setting] → [GOT IP Address Setting] from the menu to display the [GOT 

Ethernet Setting] window ([GOT IP Address Setting]).
Step 4 In the [Wireless LAN] tab, set the following items.

• Select [Update GOT wireless LAN I/F setting].
• Set [GOT IP Address].
• Set [Subnet Mask].
• Select [Enable wireless LAN I/F].

Step 5 Click the [Driver Setting] button to display the [Detail Setting] dialog.
Step 6 Set the following items, and click the [OK] button.

• Set [GOT Net No.].
• Set [GOT Station].

Step 7 In the [GOT Ethernet Setting] window, click the [OK] button.
Step 8 Select [Common] → [GOT Ethernet Setting] → [GOT Ethernet Common Setting] from the menu to display 

the [GOT Ethernet Setting] window ([GOT Ethernet Common Setting]).
Step 9 Set the following items, and click the [OK] button.

• Set [Default Gateway].
• Set [Peripheral S/W Communication Port No.].
• Set [Transparent Port No.].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Wireless LAN access point
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■4 Precautions

Not available to GT2505-V and GT25HS-V.

(1) Communication with a controller via a wireless LAN
The GOT cannot communicate with a controller such as a PLC by using a wireless LAN communication unit of the GOT.
To monitor the devices of a controller through the wireless LAN communication unit, use the functions available when the 
wireless LAN function is used.
For available functions, refer to the following.

➟5.3.12 ■1 (3) Available GOT functions when the wireless LAN function is used

(2) Precautions when using a wireless LAN
A communication may be disconnected since the radio wave condition changes dynamically due to the wireless LAN's 
characteristic.
Consider the wireless environment, disconnection of a communication, and other causes when using a wireless LAN.

■5 [Wireless LAN Setting]

Not available to GT2505-V and GT25HS-V.
In [Wireless LAN Setting], set the operation mode and the wireless LAN access point for the wireless LAN function.
Select [Common] → [GOT Setup] → [Advanced Setting] → [Wireless LAN Setting] from the menu to display this window.

1) [Update the wireless LAN setting]
Overwrites the description set with GT Designer3 to the GOT when the package data is written.
Select this item to set each item in [Wireless LAN Setting].

2) [GOT IP Address Setting] button
Displays the [Wireless LAN] tab of the [GOT Ethernet Setting] window ([GOT IP Address Setting]).
Set an IP address for the wireless LAN interface.

➟5.4.1 ■3 (3) [Wireless LAN] tab
3) [Operation Mode]

Select the operation mode for the wireless LAN function.
The setting items differ according to the operation mode.

• [Station]
Sets the GOT as a station.

➟(1) [Station]
• [Access Point]

Sets the GOT as a wireless LAN access point.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟(2) [Access Point]

(1) [Station]

1) [New Row] button
Creates a new access point setting in the access point list.

2) [Insert Row] button
Inserts a row in the access point list.

3) [Cut] button
Cuts the selected access point setting from the access point list.

4) [Copy] button
Copies the selected access point setting from the access point list.

5) [Paste] button
Pastes the copied access point setting to the access point list.

6) [Clear] button
Clears the selected cells.

7) [Delete] button
Deletes the selected access point setting from the access point list.

8) [Import] button
Imports the settings that were edited in a Unicode text file or CSV file to GT Designer3.

9) [Export] button
Saves the settings made in this dialog as a Unicode text file or CSV file.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

10) Access point list
The list of access point settings to be used for a wireless LAN connection.
Up to eight wireless LAN access points can be registered.

Item Description

[No.] No. of access point settings

[Name] Set the name of the access point setting Up to 30 alphanumeric characters can be set.

[SSID]

Set the SSID of the wireless LAN access point.
Up to 32 characters can be set.
One-byte alphanumeric characters, one-byte spaces, and the following symbols are 
available for SSID.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~

10)

1) 2) 3) 4) 5) 6) 7) 8) 9)

11)
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11) [Destination Access Point Specification]
Specify the access point No. to be used from the access point list.

(2) [Access Point]

1) Access point setting
Configure the setting to make the GOT operate as a wireless LAN access point.

[Security Authentication]

Select the security authentication method of the wireless LAN access point.
The following shows the items to be selected.
• [None]
• [WEP64]
• [WEP128]
• [WPA-PSK (TKIP)]
• [WPA-PSK (AES)]
• [WPA2-PSK (TKIP)]
• [WPA2-PSK (AES)]

[WEP Key/Passphrase]

Set the WEP key or passphrase of the wireless LAN access point.
Click the [...] button and input the WEP key or the passphrase.

• [Text]
Input the WEP key or the passphrase in the text.

• [Hexadecimal]
Input the WEP key or the passphrase in hexadecimal.

Item Description

Item Description

[SSID]
Set the SSID of the GOT (wireless LAN access point). Up to 32 characters can be set. One-
byte alphanumeric characters, one-byte spaces, and the following symbols are available 
for SSID. !"#$%&'()*+,-./:;<=>?@[\]^_`{|}~

[Security Authentication]

Set the security authentication method of the GOT (wireless LAN access point). The 
following shows the items to be selected.
• [None]
• [WEP64]
• [WEP128]
• [WPA-PSK (TKIP)]
• [WPA-PSK (AES)]
• [WPA2-PSK (TKIP)]
• [WPA2-PSK (AES)]
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■6 Relevant settings

Not available to GT2505-V and GT25HS-V.
Set the relevant settings other than the specific settings for the wireless LAN function as required.
The following shows the functions that are available by the relevant settings.

(1) GOT internal device
➟12.1.3 GOT special register (GS)

[WEP Key/Passphrase]

Set the WEP key or passphrase of the GOT (wireless LAN access point). Click the [...] 
button and input the WEP key or the passphrase.

• [Text]
Input the WEP key or the passphrase in the text.

• [Hexadecimal]
Input the WEP key or the passphrase in hexadecimal.

• Password display switching button
Hides or displays the characters entered.

[Wireless Channel]
Set the wireless channel of the GOT (wireless LAN access point). The setting range is 1 to 
11. The channel number must differ from the channel numbers of other wireless LAN 
access points near the GOT (wireless LAN access point).

Item Description

Password display switching button

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Disabling writing of the package data (containing system applications) 
through a wireless LAN

GS1840.b0

GS1040.b0

Disabling writing of the package data (containing project data) through a 
wireless LAN

GS1840.b1

GS1040.b1

Disabling the writing of the project data, resource data, or other data via a 
wireless LAN.

GS1840.b8

GS1040.b8

Notifying that the GOT wireless LAN function is enabled GS1060.b0

Notifying that the GOT (station) is connected to a wireless LAN access point GS1060.b1

Notifying the GOT operation mode GS1060.b2

Notifying the number of stations connected to the GOT (wireless LAN access 
point) GS1072

Notifying the MAC address of the wireless LAN access point to which the 
GOT (station) is connected GS1067 to GS1069
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5.3.13 Configuring the settings of the system launcher function ([System Launcher])

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
➟■1 [System Launcher]

In [System Launcher], configure the settings of the system launcher function.
For the details of the system launcher function and the system launcher (servo network) function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

Installing system applications (extended functions)
To invoke a monitor function from the system configuration screen, install the system applications (extended 
functions) required for the system launcher function and also for the monitor function to the GOT.
Otherwise, the monitor function cannot be invoked from the system configuration screen of the system launcher.
For how to add a system application (extended function) to package data, refer to the following.
➟4.2.2 How to use the application setting

■1 [System Launcher]

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
In [System Launcher], configure the settings of the system launcher function.
Select [Common] → [GOT Setup] → [Advanced Setting] → [System Launcher] from the menu to display the following 
window.

1) [Update the setting of system launcher function]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Enables the setting items in [System Launcher] to be set.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Enable online module change]
Enables the online module change for PLCs by operating the GOT.

3) [Application Selection] button
Not available to GT SoftGOT2000.
Displays the [Application Selection] dialog.
Select a system application to be added to package data.

➟4.2.2 How to use the application setting
4) [Display the servo network configuration]

Not available to GT23 and GT SoftGOT2000.
Enables the system launcher (servo network) function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.3.14 Configuring the settings of the iQSS utility function ([iQSS Utility])

➟■1 [iQSS Utility]
■2 [CSP+ for iQSS Data Write] dialog
■3 Equipment compatible with the iQSS utility

In [iQSS Utility], configure the settings of the storage location for iQSS data (CSP+).
For the details of the iQSS utility, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

■1 [iQSS Utility]

In [iQSS Utility], specify iQSS data (CSP+) to be written to a data storage, and select a drive of the GOT as the storage 
location.
Select [Common] → [GOT Setup] → [Advanced Setting] → [iQSS Utility] from the menu to display the following window.

1) [Update the iQSS utility setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Enables the setting items in [iQSS Utility] to be set.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Data Storage Destination]
Select a drive at which iQSS data (CSP+) is located.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

3) [CSP+ for iQSS Data Write] button
Displays the [CSP+ for iQSS Data Write] dialog to write iQSS data (CSP+) to a data storage installed on the 
personal computer.

➟■2 [CSP+ for iQSS Data Write] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [CSP+ for iQSS Data Write] dialog

Write iQSS data (CSP+) to a data storage installed on the personal computer.
Select [Communication] → [CSP+ for iQSS Data Write] from the menu to display the following dialog.

1) [Model Refinement]
Narrows down iQSS data (CSP+) in [Write Target] by the entered model name.
Up to 48 one-byte characters are settable.
Numeric characters, A to Z, a to z, one-byte spaces, and the following symbols are usable.
!#$%&()+,-=@[\]^_`{}
The entered characters are case-insensitive.

2) [Write Target]
Lists iQSS data (CSP+) to be written to a data storage.
All pieces of iQSS data (CSP+) are arranged in tabs by network type.

For equipment compatible with the iQSS utility, refer to the following.
➟5.3.14 ■3 Equipment compatible with the iQSS utility

3) [Select All]
Selects all pieces of iQSS data (CSP+) in [Write Target].

4) [Deselect All]
Deselects all pieces of iQSS data (CSP+) in [Write Target].

5) [Destination Memory Card]

Item Description

Checkbox Select the iQSS data (CSP+) to be written to a data storage.

[No.] iQSS data (CSP+) number

[I/O Type] Input/output type of the target equipment

[Manufacturer] Manufacturer of the target equipment

[Model Name] Model of the target equipment

[Type] Type of the target equipment

[# of Occupied I/O]

• [Input]
Number of inputs for the target equipment

• [Output]
Number of outputs for the target equipment

[Language]

• [Japanese]
Indicates the presence or absence of the Japanese version of iQSS data (CSP+).
Displays an asterisk (*) when this version of data exists.

• [English]
Indicates the presence or absence of the English version of iQSS data (CSP+).
Displays an asterisk (*) when this version of data exists.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Select a drive (data storage) to which iQSS data (CSP+) is written.
The selectable drives depend on the personal computer.

6) [Data Size]
Displays the space of the operation memory (RAM) that is required to store the iQSS data (CSP+) selected in [Write 
Target].
For the available space in the GOT user area, refer to the following.

➟12.10.1 Data transferred to the GOT and capacity of the destination drive
7) [Memory Card Write] button

Writes data listed in [Write Target] to a data storage.

■3 Equipment compatible with the iQSS utility
(1) Anywire Corporation

Model name Type

B232SB-MX100-STP ASLINKSENSOR Input Module non-Isolated Comb type Main-Module

B232SB-SX100-STP ASLINKSENSOR Input Module non-Isolated Comb type Sub-Module

B262-HR16-IN ASLINKTERMINAL Input Module non-Isolated Input Panel Switch

B262-HR16-OUT ASLINKTERMINAL Output Module non-Isolated Output LED Display

B280PB-02U-C1220 ASLINKER Output Module non-Isolated Sink Type

B280PB-02US-C1220 ASLINKER Output Module non-Isolated Source Type

B280SB-02U-C1220 ASLINKER Input Module non-Isolated Sink Type

B280SB-02US-C1220 ASLINKER Input Module non-Isolated Source Type

B280XB-02U-C1220 ASLINKER I/O Combined Module non-Isolated Sink Type

B280XB-02US-C1220 ASLINKER I/O Combined Module non-Isolated Source Type

B281PB-02U-2D220 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-2D720 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-2D820 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-7CC20 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-CC20 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-CD220 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-CD720 ASLINKER Output Module non-Isolated Sink Type

B281PB-02U-CD820 ASLINKER Output Module non-Isolated Sink Type

B281PB-02US-2D220 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-2D720 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-2D820 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-7CC20 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-CC20 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-CD220 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-CD720 ASLINKER Output Module non-Isolated Source Type

B281PB-02US-CD820 ASLINKER Output Module non-Isolated Source Type

B281SB-02U-2D220 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-2D720 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-2D820 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-7CC20 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-CC20 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-CD220 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-CD720 ASLINKER Input Module non-Isolated Sink Type

B281SB-02U-CD820 ASLINKER Input Module non-Isolated Sink Type

B281SB-02US-2D220 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-2D720 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-2D820 ASLINKER Input Module non-Isolated Source Type
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B281SB-02US-7CC20 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-CC20 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-CD220 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-CD720 ASLINKER Input Module non-Isolated Source Type

B281SB-02US-CD820 ASLINKER Input Module non-Isolated Source Type

B281XB-02U-2D220 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-2D620 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-2D720 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-2D820 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-7CC20 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-CC20 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-CD220 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-CD620 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-CD720 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02U-CD820 ASLINKER I/O Combined Module non-Isolated Sink Type

B281XB-02US-2D220 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-2D620 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-2D720 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-2D820 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-7CC20 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-CC20 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-CD220 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-CD620 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-CD720 ASLINKER I/O Combined Module non-Isolated Source Type

B281XB-02US-CD820 ASLINKER I/O Combined Module non-Isolated Source Type

B283SB-01-1KC ASLINKSENSOR Input Module non-Isolated Separate Type(Receiver)

B283SB-01-1KP ASLINKSENSOR Output Module non-Isolated Separate Type(Light source)

B283SB-01-1KR ASLINKSENSOR Input Module non-Isolated Retroreflective type

B283SB-01-1KS ASLINKSENSOR Input Module non-Isolated Diffuse reflection type

B284SB-01-1KLP30  *1 ASLINKSENSOR Input Module non-Isolated Compound pressure(-100~100kPa)

B284SB-01-1KLP30A ASLINKSENSOR Input Module non-Isolated Compound pressure(-100~100kPa)

B284SB-01-1KNP30  *1 ASLINKSENSOR Input Module non-Isolated Negative pressure(-100~0kPa)

B284SB-01-1KNP30A ASLINKSENSOR Input Module non-Isolated Negative pressure(-100~0kPa)

B284SB-01-1KPLP30  *1 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~100KPa)

B284SB-01-1KPLP30A ASLINKSENSOR Input Module non-Isolated Positive pressure(0~100KPa)

B284SB-01-1KPP30  *1 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~1MPa)

B284SB-01-1KPP30A ASLINKSENSOR Input Module non-Isolated Positive pressure(0~1MPa)

B284SB-02-1KLP30  *1 ASLINKSENSOR Input Module non-Isolated Compound pressure(-100~100kPa)

B284SB-02-1KLP30A ASLINKSENSOR Input Module non-Isolated Compound pressure(-100~100kPa)

B284SB-02-1KNP30  *1 ASLINKSENSOR Input Module non-Isolated Negative pressure(-100~0kPa)

B284SB-02-1KNP30A ASLINKSENSOR Input Module non-Isolated Negative pressure(-100~0kPa)

B284SB-02-1KPLP30  *1 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~100KPa)

B284SB-02-1KPLP30A ASLINKSENSOR Input Module non-Isolated Positive pressure(0~100KPa)

B284SB-02-1KPP30  *1 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~1MPa)

B284SB-02-1KPP30A ASLINKSENSOR Input Module non-Isolated Positive pressure(0~1MPa)

B284SB-J1-1KLP30 ASLINKSENSOR Input Module non-Isolated Compound pressure(-100~100kPa)

B284SB-J1-1KNP30 ASLINKSENSOR Input Module non-Isolated Negative pressure(-100~0kPa)

Model name Type
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B284SB-J1-1KPLP30 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~100KPa)

B284SB-J1-1KPP30 ASLINKSENSOR Input Module non-Isolated Positive pressure(0~1MPa)

B285SB-01-1K1 ASLINKSENSOR Input Module non-Isolated Cylinder Switch

B289SB-01AF-CAM20 ASLINKAMP Input Module non-Isolated Fiber Sensor Amplifier

B289SB-01AF-CAS ASLINKAMP Input Module non-Isolated Fiber Sensor Amplifier

B289SB-01AK-CAM20 ASLINKAMP Input Module non-Isolated Proximity Sensor Amplifier

B289SB-01AK-CAS ASLINKAMP Input Module non-Isolated Proximity Sensor Amplifier

B289SB-01AP-CAM20 ASLINKAMP Input Module non-Isolated Photoelectronic Sensor Amplifier

B289SB-01AP-CAS ASLINKAMP Input Module non-Isolated Photoelectronic Sensor Amplifier

B295SB-01-1K24 ASLINKSENSOR Input Module non-Isolated Proximity Switch(M8 Screw type)

B295SB-01-1K25 ASLINKSENSOR Input Module non-Isolated Proximity Switch(M12 Screw type)

B295SB-01-1K26 ASLINKSENSOR Input Module non-Isolated Proximity Switch(M18 Screw type)

B295SB-01-1K27 ASLINKSENSOR Input Module non-Isolated Proximity Switch(M30 Screw type)

B297SB-01-1K40 ASLINKSENSOR Input Module non-Isolated Photointerrupter(Standard type)

B298PB-02U-M12 ASLINKER Output Module non-Isolated Sink Type

B298PB-02US-M12 ASLINKER Output Module non-Isolated Source Type

B298SB-02U-M12 ASLINKER Input Module non-Isolated Sink Type

B298SB-02US-M12 ASLINKER Input Module non-Isolated Source Type

B298XB-02U-M12 ASLINKER I/O Combined Module non-Isolated Sink Type

B298XB-02US-M12 ASLINKER I/O Combined Module non-Isolated Source Type

B2N87SB-02D-CC20 ASLINKER Input Module Non-Isolated Sink Type

B2N87SB-02DS-CC20 ASLINKER Input Module Non-Isolated Source Type

BA-F116(-12) ASLINKAMP Input Module non-Isolated Fiber Sensor Amplifier

BL2109PB-04PS-1K ASLINKTERMINAL Output Module Isolated Source Type

BL227PB-T07P02V-P POKAYOKETERMINAL Output Module Isolated No Definition

BL227PB-T07P06M-P POKAYOKETERMINAL Output Module Isolated No Definition

BL227PB-T14P02V-P POKAYOKETERMINAL Output Module Isolated No Definition

BL227PB-T14P06M-P POKAYOKETERMINAL Output Module Isolated No Definition

BL227XB-K02VL-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K02VN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K02V-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K06ML-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K06MN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K06M-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K71MN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K71M-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K71VN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K71V-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K72MN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K72M-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K72N-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K72VN-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-K72V-P POKAYOKETERMINAL I/O Combined Module Isolated No Definition

BL227XB-T07P02V-C POKAYOKETERMINAL Input Module Isolated No Definition

BL227XB-T07P06M-C POKAYOKETERMINAL Input Module Isolated No Definition

BL227XB-T14P02V-C POKAYOKETERMINAL Input Module Isolated No Definition

BL227XB-T14P06M-C POKAYOKETERMINAL Input Module Isolated No Definition

Model name Type
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BL264PB-16FS-T5 ASLINKTERMINAL Output Module Isolated Source type

BL264PB-16F-T5 ASLINKTERMINAL Output Module Isolated Sink Type

BL265PB-16F-2-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL265PB-16FS-2-20 ASLINKTERMINAL Output Module Isolated Source Type

BL265PB-32F-2-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL265PB-32FS-2-20 ASLINKTERMINAL Output Module Isolated Source Type

BL265SB-16F-2-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL265SB-16FS-2-20 ASLINKTERMINAL Input Module Isolated Source Type

BL265SB-32F-2-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL265SB-32FS-2-20 ASLINKTERMINAL Input Module Isolated Source Type

BL265XB-18F-E84-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL265XB-32F-2-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL265XB-32FS-2-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL287PB-02F-2D220 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-2D720 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-2D820 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-7CC20 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-CC20 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-CD220 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-CD720 ASLINKER Output Module Isolated Sink Type

BL287PB-02F-CD820 ASLINKER Output Module Isolated Sink Type

BL287PB-02FS-2D220 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-2D720 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-2D820 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-7CC20 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-CC20 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-CD220 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-CD720 ASLINKER Output Module Isolated Source Type

BL287PB-02FS-CD820 ASLINKER Output Module Isolated Source Type

BL287SB-02F-2D220 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-2D720 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-2D820 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-7CC20 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-CC20 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-CD220 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-CD720 ASLINKER Input Module Isolated Sink Type

BL287SB-02F-CD820 ASLINKER Input Module Isolated Sink Type

BL287SB-02FS-2D220 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-2D720 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-2D820 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-7CC20 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-CC20 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-CD220 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-CD720 ASLINKER Input Module Isolated Source Type

BL287SB-02FS-CD820 ASLINKER Input Module Isolated Source Type

BL287XB-02F-2D220 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-2D620 ASLINKER I/O Combined Module Isolated Sink Type
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BL287XB-02F-2D720 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-2D820 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-7CC20 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-CC20 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-CD220 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-CD620 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-CD720 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02F-CD820 ASLINKER I/O Combined Module Isolated Sink Type

BL287XB-02FS-2D220 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-2D620 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-2D720 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-2D820 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-7CC20 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-CC20 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-CD220 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-CD620 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-CD720 ASLINKER I/O Combined Module Isolated Source Type

BL287XB-02FS-CD820 ASLINKER I/O Combined Module Isolated Source Type

BL296PB-04F-4A-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-04F-4B-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-04FS-4A-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-04FS-4B-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08F ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-10-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-11 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-11-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-3 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-3-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-4-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-4A-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-4E-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08F-9-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08FS ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-10-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-11 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-11-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-3 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-3-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-4-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-4A-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-4E-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-9-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08FS-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-08F-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-08RS ASLINKTERMINAL Output Module Isolated G2R-1-SN DC24V
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BL296PB-08RSN ASLINKTERMINAL Output Module Isolated DriverOnly

BL296PB-08RSS ASLINKTERMINAL Output Module Isolated G3R-ODX02SN DC5-24

BL296PB-08RSS1 ASLINKTERMINAL Output Module Isolated G3R-OA202SZN DC5-24

BL296PB-08RSS2 ASLINKTERMINAL Output Module Isolated G3R-OA202SLN DC5-24

BL296PB-08RSS3 ASLINKTERMINAL Output Module Isolated G3RZ-201SLN DC24

BL296PB-08RSS4 ASLINKTERMINAL Output Module Isolated G3R-OD201SN DC5-24

BL296PB-16F-11-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-16F-3-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-16F-4A-20 ASLINKTERMINAL Output Module Isolated Sink Type

BL296PB-16FS-11-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-16FS-3-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-16FS-4A-20 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-16FS-V50 ASLINKTERMINAL Output Module Isolated Source Type

BL296PB-16F-V50 ASLINKTERMINAL Output Module Isolated Sink Type

BL296SB-04F-4A-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-04F-4B-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-04F-4PA-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-04FS-4A-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-04FS-4B-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08F ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-10-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-11 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-11-V50 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-3 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-3-V50 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-4-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-4A-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-4E-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-4P-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-4PA-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08F-9-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-08FS ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-10-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-11 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-11-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-20 ASLINKTERMINAL Input Module Isolated Source Type

BL296SB-08FS-3 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-3-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-4-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-4A-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-4E-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-9-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08FS-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-08F-V50 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-16F-11-V50 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-16F-3-V50 ASLINKTERMINAL Input Module Isolated Sink Type
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BL296SB-16F-4A-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-16F-4PA-20 ASLINKTERMINAL Input Module Isolated Sink Type

BL296SB-16FS-11-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-16FS-3-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-16FS-4A-20 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-16FS-V50 ASLINKTERMINAL Input Module Isolated Source type

BL296SB-16F-V50 ASLINKTERMINAL Input Module Isolated Sink Type

BL296XB-04F-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-04F-4B-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-04F-4PA-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-04FS-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-04FS-4B-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08F ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-10-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-11 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-11-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-3 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-3-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-4-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-4E-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-4P-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-4PA-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08F-9-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08FS ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-10-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-11 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-11-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-3 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-3-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-4-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-4E-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-9-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08FS-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-08F-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08P-4-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-08P-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-16F-11-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-16F-3-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-16F-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-16F-4PA-20 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL296XB-16FS-11-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-16FS-3-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-16FS-4A-20 ASLINKTERMINAL I/O Combined Module Isolated Source Type
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BL296XB-16FS-V50 ASLINKTERMINAL I/O Combined Module Isolated Source Type

BL296XB-16F-V50 ASLINKTERMINAL I/O Combined Module Isolated Sink Type

BL2EMSB-08F-B ASLINKTERMINAL Input Module Isolated Sink Type

BL2L87PB-02F-CC20 ASLINKER Output Module Isolated Sink Type

BL2L87SB-02F-CC20 ASLINKER Input Module Isolated Sink Type

BL2L87XB-02F-CC20 ASLINKER I/O Combined Module Isolated Sink Type

BL2LN87SB-02D-CC20 ASLINKER Input Module Isolated Sink Type

BL2LN87SB-02DS-CC20 ASLINKER Input Module Isolated Source Type

BM-C27-DM9-3012-5050 ASLINKSENSOR Input Module non-Isolated Cylinder Sensor

BM-C27-DM9-50-5050 ASLINKSENSOR Input Module non-Isolated Cylinder Sensor

BM-K1117G-M04-1K ASLINKSENSOR Input Module non-Isolated M4 amplifier relay type

BM-K1117G-M04-3012 ASLINKSENSOR Input Module non-Isolated M4 amplifier relay M12CN type

BM-K1117G-M05-1K ASLINKSENSOR Input Module non-Isolated M5 amplifier relay type

BM-K1117G-M05-3012 ASLINKSENSOR Input Module non-Isolated M5 amplifier relay M12CN type

BM-K1117G-S04-1K ASLINKSENSOR Input Module non-Isolated d4 amplifier relay type

BM-K1117G-S04-3012 ASLINKSENSOR Input Module non-Isolated d4 amplifier relay M12CN type

BM-K1117G-S05-1K ASLINKSENSOR Input Module non-Isolated d5.4 amplifier relay type

BM-K1117G-S05-3012 ASLINKSENSOR Input Module non-Isolated d5.4 amplifier relay M12CN type

BS-H0117-1KC ASLINKSENSOR Input Module non-Isolated Separate Type(Receiver)

BS-H0117-1KP ASLINKSENSOR Output Module non-Isolated Separate Type(Light source)

BS-H0117-30C12 ASLINKSENSOR Input Module non-Isolated Separate Type(Receiver)

BS-H0117-30P12 ASLINKSENSOR Output Module non-Isolated Separate Type(Light source)

BS-H0117G-1KC ASLINKSENSOR Input Module non-Isolated Separate Type(Receiver)

BS-H0117G-1KP ASLINKSENSOR Output Module non-Isolated Separate Type(Light source)

BS-H0217-1K ASLINKSENSOR Input Module non-Isolated Retroreflective type

BS-H0217-3012 ASLINKSENSOR Input Module non-Isolated Retroreflective type

BS-H0217G-1K ASLINKSENSOR Input Module non-Isolated Retroreflective type

BS-H0317-1K ASLINKSENSOR Input Module non-Isolated Diffuse reflection type

BS-H0317-3012 ASLINKSENSOR Input Module non-Isolated Diffuse reflection type

BS-H0317G-1K ASLINKSENSOR Input Module non-Isolated Diffuse reflection type

BS-K1117C-M12-1K ASLINKSENSOR Input Module non-Isolated M12 chemical resistant type

BS-K1117C-M12-3012 ASLINKSENSOR Input Module non-Isolated M12 Chemical resistant type

BS-K1117C-M18-1K ASLINKSENSOR Input Module non-Isolated M18 chemical resistant type

BS-K1117C-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 Chemical resistant type

BS-K1117C-M30-1K ASLINKSENSOR Input Module non-Isolated M30 chemical resistant type

BS-K1117C-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 Chemical resistant type

BS-K1117-M08-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M8 shield type

BS-K1117-M08-3012 ASLINKSENSOR Input Module non-Isolated Proximity Sensor M8 shield  type

BS-K1117-M12-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M12 shield type

BS-K1117-M12-3012 ASLINKSENSOR Input Module non-Isolated Proximity Sensor M12 shield type

BS-K1117-M18-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M18 shield type

BS-K1117-M18-3012 ASLINKSENSOR Input Module non-Isolated Proximity Sensor M18 shield type

BS-K1117-M30-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M30 shield type

BS-K1117-M30-3012 ASLINKSENSOR Input Module non-Isolated Proximity Sensor M30 shield type

BS-K1117M-M12-1K ASLINKSENSOR Input Module non-Isolated M12 full stainless body type

BS-K1117M-M12-3012 ASLINKSENSOR Input Module non-Isolated M12 full stainless body type

BS-K1117M-M18-1K ASLINKSENSOR Input Module non-Isolated M18 full stainless body type
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BS-K1117M-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 full stainless body type

BS-K1117M-M30-1K ASLINKSENSOR Input Module non-Isolated M30 full stainless body type

BS-K1117M-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 full stainless body type

BS-K1117S-M12-1K ASLINKSENSOR Input Module non-Isolated M12 spattering resistance type

BS-K1117S-M12-3012 ASLINKSENSOR Input Module non-Isolated M12 spattering resistance type

BS-K1117S-M18-1K ASLINKSENSOR Input Module non-Isolated M18 spattering resistance type

BS-K1117S-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 spattering resistance type

BS-K1117S-M30-1K ASLINKSENSOR Input Module non-Isolated M30 spattering resistance type

BS-K1117S-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 spattering resistance type

BS-K1118-M12-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M12 IP68 type

BS-K1118-M12-3012 ASLINKSENSOR Input Module non-Isolated M12 IP68 M12CN type

BS-K1118-M18-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M18 IP68 type

BS-K1118-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 IP68 M12CN type

BS-K1118-M30-1K ASLINKSENSOR Input Module non-Isolated Proximity Sensor M30 IP68 type

BS-K1118-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 IP68 M12CN type

BS-K1217-M08-1K ASLINKSENSOR Input Module non-Isolated Proximity M08 non-shield type

BS-K1217-M08-3012 ASLINKSENSOR Input Module non-Isolated Proximity M08 non-shield type

BS-K1217-M12-1K ASLINKSENSOR Input Module non-Isolated Proximity M12 non-shield type

BS-K1217-M12-3012 ASLINKSENSOR Input Module non-Isolated Proximity M12 non-shield type

BS-K1217-M18-1K ASLINKSENSOR Input Module non-Isolated Proximity M18 non-shield type

BS-K1217-M18-3012 ASLINKSENSOR Input Module non-Isolated Proximity M18 non-shield type

BS-K1217-M30-1K ASLINKSENSOR Input Module non-Isolated Proximity M30 non-shield type

BS-K1217-M30-3012 ASLINKSENSOR Input Module non-Isolated Proximity M30 non-shield type

BS-K1217-T42A-V1K ASLINKSENSOR Input Module non-Isolated Flat type

BS-K1217-T42A-V3012 ASLINKSENSOR Input Module non-Isolated Flat M12CN type

BS-K4117-M12-1K ASLINKSENSOR Input Module non-Isolated M12 allmetal detect

BS-K4117-M12-3012 ASLINKSENSOR Input Module non-Isolated M12 allmetal detect M12CN type

BS-K4117-M18-1K ASLINKSENSOR Input Module non-Isolated M18 allmetal detect

BS-K4117-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 allmetal detect M12CN type

BS-K4117-M30-1K ASLINKSENSOR Input Module non-Isolated M30 allmetal detect

BS-K4117-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 allmetal detect M12CN type

BS-K5217-M18-1K ASLINKSENSOR Input Module non-Isolated M18 Capacitive

BS-K5217-M18-3012 ASLINKSENSOR Input Module non-Isolated M18 Capacitive M12CN type

BS-K5217-M30-1K ASLINKSENSOR Input Module non-Isolated M30 Capacitive

BS-K5217-M30-3012 ASLINKSENSOR Input Module non-Isolated M30 Capacitive M12CN type

BS-L0117-1KC ASLINKSENSOR Input Module non-Isolated LaserSensor(Through-beam)

BS-L0117-1KP ASLINKSENSOR Output Module non-Isolated LaserSensor(Through-beam)

BS-L0217-1K ASLINKSENSOR Input Module non-Isolated LaserSensor(Retroreflectivetype)

LA-A12W ASLINKAMP Input Module non-Isolated Analog input

LA-A1AW ASLINKAMP Input Module Isolated Analog input

LA-DA12W ASLINKAMP Output Module non-Isolated Analog Output

LA-DA1AW ASLINKAMP Output Module Isolated Analog Output

LA-DV12W ASLINKAMP Output Module non-Isolated Analog Output

LA-DV1AW ASLINKAMP Output Module Isolated Analog Output

LA-F1011 ASLINKAMP Input Module Isolated Fiber Sensor Amplifier

LAL-R10W ASLINKAMP Input Unit Isolated Temperature Input Unit

LB-A12W ASLINKAMP Input Module non-Isolated Analog input
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*1 To enable the alarm bit function, write the profile data of this model and the profile data of the model having "A" at the end 
of this model name.
Example: Write the profile data of [B284SB-01-1KLP30A] as well, to enable the alarm bit function of [B284SB-01-1KLP30].
Otherwise, the equipment is handled as a general-purpose slave module when the alarm bit function is enabled.

(2) NITTO KOHKI CO.

LB-A1AW ASLINKAMP Input Module Isolated Analog input

LB-DA12W ASLINKAMP Output Module non-Isolated Analog Output

LB-DA1AW ASLINKAMP Output Module Isolated Analog Output

LB-DV12W ASLINKAMP Output Module non-Isolated Analog Output

LB-DV1AW ASLINKAMP Output Module Isolated Analog Output

LB-F1011 ASLINKAMP Input Module Isolated Fiber Sensor Amplifier

LBL-R10W ASLINKAMP Input Unit Isolated Temperature Input Unit

LSL-H011-1KC ASLINKSENSOR Input Module Isolated Separate Type(Receiver)

LSL-H011-1KP ASLINKSENSOR Output Module Isolated Separate Type(Light source)

LSL-H021-1K ASLINKSENSOR Input Module Isolated Retroreflective type

LSL-H031-1K ASLINKSENSOR Input Module Isolated Diffuse reflection type

Model name Type

Model name Type

DELVO ASLINKTERMINAL I/O Combined Module Isolated Sink Type
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5.3.15 Configuring the network drive settings ([Network Drive])

In [Network Drive], specify a shared folder on the file server (such as a personal computer) as the network drive.
The GOT is connected to the file server via Ethernet.
The file server must support the file sharing function (SMB or CIFS).
For recommended file servers, refer to the following.

➟5.3.15 ■1 (6) Validated file servers

■1 Network drive specifications

(1) System application (extended function)
To use the network drive, a system application (extended function) of [Network Drive] is required.
Configuring one of the following settings incorporates the application into the package data automatically.

• Selecting [Update the network drive setting] in [Network Drive] in the [GOT Setup] window.
➟5.3.15 ■6 [Network Drive]

• Selecting [N:Network Drive] for [Drive Name] in the setting dialog of a function using the network drive.
To use the network drive for GT SoftGOT2000, the application is not required.

(2) CoreOS version
To use the network drive, install CoreOS version L or later on the GOT.

(3) BootOS version
To use the network drive, install BootOS version AK or later on the GOT.

(4) Functions that can use the network drive
• Document display object

➟8.26 Placing a Document Display
• Logging function

➟9.2 Collecting Device Data ([Logging])
• Hard copy function

➟9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard Copy])
• File print function

➟GOT2000 Series User's Manual (Utility)
• Report function

➟10.11 Outputting the Collected Data as a Report (Report Function)
• File transfer function (FTP transfer)

➟10.17 Transferring a File between the GOT and Peripheral Device (File Transfer Function (FTP Transfer))
• File transfer function (GOT internal transfer)

➟10.18 Transferring a File between the Drives (File Transfer Function (GOT Internal Transfer))
• File manager

➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOTFile server

Shared folder

Network drive
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(5) Port number when the network drive is used
Port No. 445 is used for the file server.

(6) Validated file servers
The following shows the file servers that have been validated by Mitsubishi Electric Corporation.

• Windows Server 2016 Essentials
• Windows 10 Enterprise

■2 System configuration when using the network drive

The following shows the system configuration when using the network drive.

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or othersystem equipment 
according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LANadapter, refer to 
the manual of the wireless LAN adapter you use.

*2 A straight cable is usable.
A cross cable is usable for directly connecting the GOT to a file server.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use.
When repeater hubs are used, the number of connectable hubs is as follows.
• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)
• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

File server Connection cable*1*2,
wireless LAN access point

Maximum 
segment 
length*3

GOT
PLC

Option GOT 
model

Select by each 
user

• 10BASE-T
Shielded twisted pair cable (STP) 
orunshielded twisted pair cable 
(UTP):Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable 
(STP):Category 5 and 5e

100m

- (Built into GOT)
GT27
GT25
GS25

For the system 
configuration 
between the 
GOT and the 
PLC, refer to 
each connection 
manual.

GT25-J71E71-100
GT27

GT25*6

GT SoftGOT2000

- - GT25-WLAN
GT27*4

GT25*4*6

GS25*4

• Wireless LAN access point
For the connectable wireless LAN access 
points and system devices, refer to the 
following Technical News.
➟List of Valid Devices Applicable for 

GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-0160)

- GT25-WLAN
GT27*5

GT25*5*6

GS25*5

• Wireless LAN access point *7 - GT SoftGOT2000

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC

Available cables differ depending
on the connection type.

Wireless LAN
access point

Connection cable

Connection cable,
wireless LAN access point GOT

File server

GT SoftGOT2000
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➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Not available to GT2505-V and GT25HS-V.
*7 The usable wireless LAN access point varies with the personal computer used.

■3 How to use the network drive

To enable the network drive, configure the settings on GT Designer3 and a file server.
The following shows an example of using the folder sharing feature in Windows 10 to specify the selected folder as the 
network drive.

(1) Settings on GT Designer3
Step 1 Set the GOT Ethernet interface.

➟5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])
Step 2 To use the GOT wireless LAN function, configure the wireless LAN connection setting.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
Step 3 Configure the network drive settings.

➟5.3.15 ■6 [Network Drive]
Step 4 Configure settings on the file server.

➟(3) Settings on the file server
Step 5 Connect the personal computer to the GOT, and write the project to the GOT.

➟4.3 Transferring the Data between the Personal Computer and the GOT

(2) Settings on GT SoftGOT2000
For information on how to use the network drive for GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(3) Settings on the file server
Configure the following settings with administrator privileges on Windows.

• Set a user who accesses the file server area from the GOT.
In [Control Panel], select [System and Security] → [Administrative Tools] → [Computer Management] → [Local Users 
and Groups]. Right-click [Users] and select [New User] from the context menu.
In the [New User] dialog, set the following items.

• [User name]
• [Password]
• [User must change password at next logon]: Deselected, [Password never expires]: Selected

• Check or set the computer name.
In [Control Panel], select [System and Security] → [System].
For checking: Check the computer name on the [System] window.
For setting: Select [Advanced system settings]. In the [Computer Name] tab in the [System Properties] dialog, click 
the [Change] button and set the computer name.

• Check the name of the folder to be shared or create a new shared folder.
In [Control Panel], select [System and Security] → [Administrative Tools] → [Computer Management] → [System 
Tools] → [Shared Folders] → [Shares].
For checking: Check the name of the folder to be shared from the list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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For creating: Right-click [Shares] and select [New] or [New Share] to open [Create A Shared Folder Wizard]. 
Configure the settings for the shared folder accordingly.

• Change the Windows Defender firewall setting.
In [Control Panel], select [System and Security] → [Windows Defender Firewall] → [Advanced settings].
Select [Inbound Rules] in the [Windows Defender Firewall with Advanced Security] window.
Right-click each [File and Printer Sharing (SMB-In)] and select [Enable Rule] to enable the setting.

■4 Creating a folder for each GOT

A folder is created for each GOT to save files.
Even when the file save destination setting is common to the GOTs, the files of each GOT will be saved into different folders.
Each folder is created automatically and named as the IP address of each GOT.
Select [Separate destinations for each GOT] in the setting dialog for a function using the network drive.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Example) Settings for GOT 1 and GOT 2
　　- Path to the network drive: \\192.168.5.32\share
　　- Save destination of logging files
　　　・[Drive Name]: [N:Network Drive]
　　　・[Folder Name]: LOG
　　　・[File Name]: LOG001.G2L

share 

192.168.5.18

LOG

192.168.5.19

LOG

IP: 192.168.5.32

File server

IP: 192.168.5.18

GOT 1

IP: 192.168.5.19

GOT 2

LOG001.G2L

LOG001.G2L

The folder is named as the IP address 
of the GOT.

2) When [Separate destinations for each GOT] is selected 

IP: 192.168.5.32

File server

IP: 192.168.5.18

GOT 1

share 

LOG

As the logging files of the GOTs are 
saved into the same folder, logging 
cannot be executed normally.

IP: 192.168.5.19

GOT 2

LOG001.G2L

LOG001.G2L

The file save 
destination 
setting is 
common to 
the GOTs.

1) When [Separate destinations for each GOT] is deselected

The file save 
destination 
setting is 
common to 
the GOTs.

The folder is named as the IP address 
of the GOT.

As a folder is automatically created 
for each GOT, the files of each GOT 
are saved into different folders.
5 - 274 5. COMMON SETTING
5.3 Setting the Utility Function ([GOT Setup])



5

C
O

M
M

O
N

 S
ET

TI
N

G

(1) Applicable functions
The following shows the applicable functions.
Select [Separate destinations for each GOT].

• Logging function
➟9.2.6 [Logging] dialog

• Hard copy function
➟9.7.6 [Hard Copy] dialog

• Report function
➟2.7.3 ■2 [Action] tab

(2) Folder name determination
Each folder is named as the IP address of the GOT's Ethernet interface connected to the file server.
If the GOT is not connected to the file server, no folder will be created.

(3) Changing the IP address of a GOT
When the IP address of a GOT is changed, files will be saved to the folder named as the new IP address.
If a folder named as the new IP address already exists, files will be saved to the folder.
Otherwise, a folder named as the new IP address will be created automatically.

■5 Precautions for the network drive

(1) Slow access speed
The GOT takes a longer time to start up, save a file, or display a graph via the network drive compared with via an SD 
card.

(2) When multiple GOTs use the network drive
If the GOTs have the same file save destination, select [Separate destinations for each GOT] in the setting of each 
applicable function as necessary to avoid overwriting files.

➟5.3.15 ■4 Creating a folder for each GOT

(3) Time zone setting
Set the same time zone for the file server and GOT.
Otherwise, a time difference will occur in the timestamps of folders and files between the file server and GOT.

➟5.3.5 ■3 (3) [Local Time] tab

(4) Time stamp of a copied file
If you copy a file from a location to the network drive, the time stamp of the copied file will be updated to the date and 
time of the copy operation.

(5) Setting a read-only folder
To set a read-only folder on the file server, set the folder permissions.
In the folder properties dialog, set [Permissions] on the [Security] tab.

(6) When the file server is under heavy load
When the file server is under heavy load, a timeout may occur.
Specify a longer time for [Timeout Time].

➟5.3.15 ■6 [Network Drive]

(7) When system alarm 391 occurs
This alarm occurs when the user name or password setting is inconsistent between the GOT and the file server.
As no automatic reconnection is performed in this case, correct the user name or password setting and then restart the 
GOT.

(8) User name and password change
The settings of the connected network drive cannot be changed directly on the GOT.
To change [User name] or [Password] of the connected network drive, both the file server's setting and the GOT's setting 
need to be changed.
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■6 [Network Drive]

In [Network Drive], configure the settings to connect the GOT to a file server.
Select [Common] → [GOT Setup] → [Advanced Setting] → [Network Drive] from the menu to display the following window.

1) [Update the network drive setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written to the GOT.

2) [Use network drive]
Enables access to the network drive.

3) [Drive Name]
Displays the network drive name.
The name is fixed to [N:Network Drive].

4) [Drive Path]
Displays the path to the network drive.
The drive path consists of the specified IP address, shared name, and folder path.
Make sure that the number of characters (including delimiters) in the drive path is 60 or less.

5) [IP Address]
Specify the IP address of a file server to be connected.
The setting range is [0.0.0.0] to [255.255.255.255].

6) [Shared Name]
Enter the name of the shared folder (network drive) on the file server.
Make sure that the number of characters (including delimiters) in the drive path is 60 or less.
Two-byte and one-byte characters can be entered.

7) [Folder Path]
Set this item when specifying a folder under the shared folder as the network drive.
Make sure that the number of characters (including delimiters) in the drive path is 60 or less.
Two-byte and one-byte characters can be entered.
If this setting is unnecessary, leave it blank.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1）

2）

3）
4）
5）
6）
7）

8）
9）

10）

\\192.168.5.101\Share\mount\doc

[IP Address] [Shared Name] [Folder Path] 
(optional)

[Drive Path] (up to 60 characters)

Delimiter Delimiter Delimiter
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8) [User Name]
Set the name of a user that accesses the network drive.
Specify a local user.
A domain user is not supported.
Up to 32 characters can be entered.

9) [Password]
Set a password for the user to access the network drive.
Up to 32 one-byte alphanumeric characters can be entered.
If this setting is unnecessary, leave it blank.

10) [Timeout Time]
Set a communication timeout period.
The setting range is [3] seconds to [255] seconds.

■7 Relevant settings for the network drive

Set the relevant settings other than the specific settings for the network drive as required.
The following shows the functions that are available by configuring the relevant settings.

(1) GOT type settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] window.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

(2) GOT internal devices
➟12.1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying the free space of the network drive.
(Write device)

[Drive N empty capacity information(32bit)]

Notifying that the network drive is being accessed.
(Write device: Extended Drive Information.b9)

[Extended Drive Information]

Notifying that the free space of the network drive is less than 1k byte.
(Write device: Extended Drive Information.b10)

[Extended Drive Information]

Notifying that an error has occurred while the network drive is being accessed.
(Write device: Extended Drive Information.b11)

[Extended Drive Information]

Function Setting item

Notifying that data can be read from or written to the network drive. GS251.b5
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5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])

Not available to GT2105-Q.
➟5.4.1 Setting the GOT IP address

5.4.2 Configuring the settings common to Ethernet interfaces
5.4.3 Setting the IP filter

5.4.1 Setting the GOT IP address

Not available to GT2105-Q.
➟■1 Ethernet interfaces
■2 Precautions
■3 [GOT IP Address Setting]

Set an IP address and a subnet mask for each Ethernet interface of the GOT.
For setting the default gateway, refer to the following.

➟5.4.2 Configuring the settings common to Ethernet interfaces

■1 Ethernet interfaces

Not available to GT2105-Q.
The usable Ethernet interfaces vary by GOT model.

■2 Precautions

Not available to GT2105-Q.

(1) IP address setting
The same network is inaccessible through multiple Ethernet interfaces and the wireless LAN interface.
Set an IP address for each interface to access a different network.

■3 [GOT IP Address Setting]

Not available to GT2105-Q.
In [GOT IP Address Setting], set an IP address and a subnet mask for each Ethernet interface.
Select [Common] → [GOT Ethernet Setting] → [GOT IP Address Setting] from the menu to display the following window.

➟(1) [Standard Port] tab, [Port 1] tab
(2) [Extended Port] tab, [Port 2] tab
(3) [Wireless LAN] tab

The settings of the items in green cells are reflected from MELSOFT Navigator to the GOT project.
Set these items on MELSOFT Navigator.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Ethernet interface

GT27, GT25-S, GT25-V (excluding GT2505-V)
• Ethernet standard port
• Ethernet extended port
• Wireless LAN interface

GT25-W, GS25
• Ethernet standard port 1
• Ethernet standard port 2
• Wireless LAN interface

GT2505-V, GT25HS-V, GT23, GT21, GS21 • Ethernet standard port

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) [Standard Port] tab, [Port 1] tab

Not available to GT2105-Q.
The tab name varies by GOT model.

• Models other than GT25-W and GS25: [Standard Port] tab
• GT25-W, GS25: [Port 1] tab

Set an IP address and a subnet mask for the Ethernet standard port or Ethernet standard port 1.

1) [Update GOT Ethernet standard port setting] ([Update GOT Ethernet standard port 1 setting] for 
GT25-W and GS25)
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item on the [Standard Port] tab or the [Port 1] tab.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [GOT IP Address]
Set an IP address for the Ethernet standard port or Ethernet standard port 1.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

3) [Subnet Mask]
Set a subnet mask for the Ethernet standard port or Ethernet standard port 1.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

4) [Select from GOT Setting List]
Select the GOT Ethernet setting to be used among the settings registered in the [GOT Setting List] dialog.

5) [List] button
Displays the [GOT Setting List] dialog.
For the details of the settings, refer to the following.

➟5.3.2 ■5 [GOT Setting List] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)
5)
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(2) [Extended Port] tab, [Port 2] tab

Not available to GT2505-V and GT25HS-V.
The tab name varies by GOT model.

• Models other than GT25-W and GS25: [Extended Port] tab
• GT25-W, GS25: [Port 2] tab

Set an IP address and a subnet mask for the Ethernet extended port or Ethernet standard port 2.

1) [Update GOT Ethernet extended port setting] ([Update GOT Ethernet standard port 2 setting] for 
GT25-W and GS25)
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set each item on the [Extended Port] tab or the [Port 2] tab.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Enable Ethernet extended port] ([Enable Ethernet standard port 2] for GT25-W and GS25)
Enables the Ethernet extended port or Ethernet standard port 2.
Select [Enable Ethernet extended port] and click the [OK] button to use the smallest-numbered available stage of 
[Extend I/F Setting] in the [I/F Communication Setting] dialog as the Ethernet extended port.

3) [GOT IP Address]
Set an IP address for the Ethernet extended port or Ethernet standard port 2.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

4) [Subnet Mask]
Set a subnet mask for the Ethernet extended port or Ethernet standard port 2.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

5) [Select from GOT Setting List]
Select the GOT Ethernet setting to be used among the settings registered in the [GOT Setting List] dialog.

6) [List] button
Displays the [GOT Setting List] dialog.
For the details of the settings, refer to the following.

➟5.3.2 ■5 [GOT Setting List] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)
4)
5)

2)

6)
5 - 280 5. COMMON SETTING
5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

(3) [Wireless LAN] tab

Not available to GT2505-V and GT25HS-V.
Set the IP address and other items for the wireless LAN interface.

1) [Update GOT wireless LAN I/F setting]
Overwrites the setting data in the GOT with the ones set on GT Designer3 when package data is written.
Select this item to set the following items.
When a project is read from the GOT, the setting changed in the utility is reflected.

2) [Enable wireless LAN I/F]
Enables the wireless LAN interface.

Item Description

[GOT IP Address]
Set an IP address for the wireless LAN interface.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

[Subnet Mask]
Set a subnet mask for the wireless LAN interface.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

[Select from GOT Setting List] Select the GOT Ethernet setting to be used among the settings registered in the [GOT 
Setting List] dialog.

[List] button
Displays the [GOT Setting List] dialog.
For the details of the settings, refer to the following.

➟5.3.2 ■5 [GOT Setting List] dialog

[Specify port No. for wireless LAN] Enables the port number setting (apart from the Ethernet common setting) for the wireless 
LAN interface.

[Peripheral S/W Communication Port No.]

Set a port number for the wireless LAN interface to communicate with GT Designer3.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

[Transparent Port No.]

Set a port number for the wireless LAN interface to be used for the FA transparent function.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

Item Description

[Driver Setting] button
Displays the [Detail Setting] dialog.

➟12.15.5 [Detail Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.4.2 Configuring the settings common to Ethernet interfaces

Not available to GT2105-Q.
➟■1 [GOT Ethernet Common Setting]

Set the default gateway and other common items for Ethernet interfaces.

■1 [GOT Ethernet Common Setting]

Not available to GT2105-Q.
In [GOT Ethernet Common Setting], set the default gateway and other common items for Ethernet interfaces.
Select [Common] → [GOT Ethernet Setting] → [GOT Ethernet Common Setting] from the menu to display the following 
window.
You can set a port number common to Ethernet interfaces, and set another port number for the wireless LAN interface.

➟5.4.1 ■3 (3) [Wireless LAN] tab

The settings of the items in green cells are reflected from MELSOFT Navigator to the GOT project.
Set these items on MELSOFT Navigator.

1) [Default Gateway]
Set the default gateway.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

2) [Peripheral S/W Communication Port No.]
Set the port No. used for the communication with GT Designer3.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

3) [Transparent Port No.]
Use this port No. for the FA transparent function.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
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5.4.3 Setting the IP filter

Not available to GT2105-Q.
➟■1 Filtering method
■2 Filtering list
■3 Precautions
■4 [IP Filter Setting]
■5 [IP Address to Exclude] dialog

The IP filter allows or blocks access via an Ethernet network from IP addresses in the filtering list.
To use the IP filter, install version H or later of CoreOS on the GOT.

➟4.5.3 Installing the BootOS or the CoreOS to the GOT
For how to check the CoreOS version, refer to the following.

➟GOT2000 Series User's Manual (Utility)

■1 Filtering method

Not available to GT2105-Q.
The GOT filters access from IP addresses in the filtering list by the following filtering methods.
The filtering method is settable in [IP Filter Setting] on GT Designer3 or the GOT utility.

➟5.4.3 ■4 [IP Filter Setting]
GOT2000 Series User's Manual (Utility)

(1) Allowing specified IP addresses
The GOT allows access from IP addresses in the filtering list.
The GOT blocks access from IP addresses unlisted in the filtering list.
Excluded IP addresses are settable in the filtering list.
The GOT blocks access from the excluded IP addresses.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet

IP address: 192.168.10.200

IP address: 192.168.10.25
IP address: 192.168.10.150

Blocked

Access from an IP 
address in the filtering 
list is allowed.

Filtering list
 (to allow specified IP addresses)
 ・192.168.10.1 to 192.168.10.100
  (Excluded IP address: 192.168.10.50)
 ・192.168.10.150
 ・192.168.10.250

IP address: 192.168.10.50

Access from an excluded 
IP address is blocked.

Access from an IP address 
unlisted in the filtering list is blocked.
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(2) Blocking specified IP addresses
The GOT blocks access from IP addresses in the filtering list.
The GOT allows access from IP addresses unlisted in the filtering list.
Excluded IP addresses are settable in the filtering list.
The GOT allows access from the excluded IP addresses.

■2 Filtering list

Not available to GT2105-Q.
The filtering list contains IP addresses to be filtered.
The filtering list is settable in [IP Filter Setting] on GT Designer3 or the GOT utility.

➟5.4.3 ■4 [IP Filter Setting]
GOT2000 Series User's Manual (Utility)

(1) Maximum number of IP address ranges
• For GT27, GT25, GT23, and GS25

Up to 32 IP address ranges are registrable.
• For GT21 and GS21

Up to 4 IP address ranges are registrable.

(2) Specifying the IP address range
You can set the range of IP addresses to be registered in the filtering list.
To set the range of IP addresses, the start IP address and the end IP address must belong to the same subnet.
To set the range of IP addresses belonging to different subnets, group IP addresses by subnet for registration.
The following shows an example where the fourth octet of IP addresses indicates a subnet.
Example 1) Possible settings

• First setting: Start IP address 192.168.3.5, end IP address 192.168.3.255
• Second setting: Start IP address 192.168.4.1, end IP address 192.168.4.20

Example 2) Impossible settings
• First setting: Start IP address 192.168.3.5, end IP address 192.168.4.20
• Second setting: None

(3) Maximum number of excluded IP addresses
• For GT27, GT25, GT23, and GS25

Up to 32 excluded IP addresses are registrable.
• For GT21 and GS21

Up to 16 excluded IP addresses are registrable.

Ethernet

IP address: 128.101.10.200

IP address: 192.168.10.25 IP address: 192.168.10.150

Blocked

Access from an IP address 
unlisted in the filtering list is allowed.

Access from an IP address in 
the filtering list is blocked.

Filtering list
 (to block specified IP addresses)
 ・192.168.10.1 to 192.168.10.100
  (Excluded IP address: 192.168.10.50)
 ・192.168.10.150
 ・192.168.10.250

IP address: 192.168.10.50

Access from an excluded 
IP address is allowed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Precautions

Not available to GT2105-Q.

(1) Taking security measures except the IP filter
Using only the IP filter cannot prevent unauthorized access perfectly.
Take additional security measures system-wide, such as setting up a firewall for the network.

(2) Overlap of IP address ranges
When the IP address ranges overlap in the filtering list, the GOT prioritizes the range that has been set earlier.
If an excluded IP address overlaps with an IP address in the already-specified IP address range, the excluded IP address 
becomes invalid.
Example) Filtering method: Blocking specified IP addresses

• First setting: 192.168.3.10 to 192.168.3.100, excluded: 192.168.3.90
• Second setting: 192.168.3.80 to 192.168.3.240, excluded: 192.168.3.85

IP address 192.168.3.85 is blocked.

(3) Filtering in communication via network equipment
A source IP address may be converted depending on the network route, such as via a router having the IP address 
conversion function or via a PLC CPU by using the FA transparent function.
When a controller communicates with the GOT via network equipment whose IP address is unlisted in the filtering list, 
even if the controller IP address is in the filtering list, the IP filter is not applied.
For network configurations in which a source IP address may be changed, set the filtering list in consideration of routed 
system equipment.
Example) When CPU 1 accesses GX Works3 via CPU 2 on a different network and then via the GOT using the FA 
transparent function

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

CPU1
IP address: 192.100.20.100

GX Works3

The IP address is converted when 
the communication goes through CPU 2.
IP address： 192.168.10.5

The communication from 
CPU 1 is allowed.

Network No. 2

CPU2
IP address: 192.168.10.5

192.100.20.100
192.100.20.101

：

Filtering list 
(to block specified IP addresses)

Communication from CPU 1
IP address: 192.100.20.100

Network No. 1
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■4 [IP Filter Setting]

Not available to GT2105-Q.
In [IP Filter Setting], set the filtering method and the filtering list.
Select [Common] → [GOT Ethernet Setting] → [IP filter Setting] from the menu to display the following window.

1) [Reflect IP filter setting in the GOT]
Reflects the IP filter setting to the GOT.

2) [Use IP filter]
Enables the IP filter.

3) [Access from IP address below]
Select a filtering method applied to the filtering list.

• [Penetrate]
Allows access from IP addresses ranging from [Start IP Address] to [End IP Address] in the filtering list.
Blocks access from IP addresses set in [IP Address to Exclude].

• [Shut off]
Blocks access from IP addresses ranging from [Start IP Address] to [End IP Address] in the filtering list.
Allows access from IP addresses set in [IP Address to Exclude].

4) Filtering list
Lists IP address ranges to which the IP filter is applied.

Item Description

[Add] button Adds an IP filter setting in the bottom of the list.

[Delete] button Deletes a selected IP filter setting.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

4)

[Delete] button

No.

[Add] button
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■5 [IP Address to Exclude] dialog

Not available to GT2105-Q.

1) [Target IP Address]
Displays the IP address range to which the IP filter is applied.

2) [Add] button
Adds an excluded IP address in the bottom of the list.

3) [Delete] button
Deletes a selected excluded IP address.

4) No.
Excluded IP address setting No.
Clicking an excluded IP address setting No. selects the row.
To select multiple rows, perform one of the following operations.
Hold down the [Ctrl] key and click a setting No. To deselect a selected row, perform the same operation.
Select the first row in the range, hold down the [Shift] key, and click a setting No. to select the last row in the range.

5) [IP Address to Exclude]
Lists the IP addresses excluded from being filtered.

No.

IP filter setting No.
Clicking an IP filter setting No. selects the row.
To select multiple rows, perform one of the following operations.
Hold down the [Ctrl] key and click a setting No. To deselect a selected row, perform the same 
operation.
Select the first row in the range, hold down the [Shift] key, and click a setting No. to select the last 
row in the range.

[Range]
Enables the registration of IP addresses by specifying a range.
To register IP addresses one by one, clear this item.

[Start IP Address] Set the start IP address of the IP address range.

[End IP Address]
This item is settable only when [Range] is selected.
Set the end IP address of the IP address range.

[IP Address to Exclude]
Set IP addresses excluded from being filtered.
Click the [...] button to display the [IP Address to Exclude] dialog.

➟5.4.3 ■5 [IP Address to Exclude] dialog

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)

3)

5)
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5.5 Configuring the Communication Method between the GOT and the 
Controller ([Controller Setting])

➟5.5.1 Setting channels
5.5.2 Setting the routing information
5.5.3 Configuring the setting of the MELSEC redundant function
5.5.4 Configuring the settings for switching the target station No. for monitoring
5.5.5 Configuring the settings for switching the buffer memory unit No. of the monitoring target

5.5.1 Setting channels

➟■1 Specifications of channels
■2 How to set channels
■3 Precautions
■4 [Controller Setting]
■5 [GOT (Extend Computer)] dialog
■6 [Controller Type List] window

Set the channel used for the connection between the GOT and controllers.

■1 Specifications of channels

(1) Applicable channels
The following shows the channels that are available for each GOT model.

CH2 to CH4 can be used only when the multi-channel function is used.
GT SoftGOT2000 can monitor multiple channels by using the following connections.

• Ethernet connection
• OPC UA client connection
• Microcomputer connection (serial)

For the details of the multi-channel function, refer to the following.
➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

GT SoftGOT2000 Version1 Operating Manual

(2) Applicable communication interfaces
The following shows the communication interfaces that are available for each GOT model.

For the details of the applicable communication interfaces, refer to the following.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT model Applicable channel No.

GT27, GT25, GT SoftGOT2000, GS25 CH1 to CH4

GT23, GT21, GS21 CH1 to CH2

GOT model Supported communication interface

GT27, GT25-S, GT25-V 
(excluding GT2505-V)

[Standard I/F(RS422/485)], [Standard I/F(RS232)], [Ethernet: Multi], [Extend I/F(1st)], [Extend I/F(2nd)], and 
[Extend I/F(3rd)]

GT25-W, GT2505-V, GT25HS-V, 
GS25 [Standard I/F(RS422/485)], [Standard I/F(RS232)], and [Ethernet: Multi]

GT23, GT2107-W, GT2104-R, 
GS21 [Standard I/F(RS422/485)], [Standard I/F(RS232)], and [Ethernet: Multi]

GT2105-Q [Standard I/F(RS422/485)] and [Standard I/F(RS232)]

GT2104-P, GT2103-P [Standard I/F(RS422/485/232(Side))], [Standard I/F(RS232(Back))], and [Ethernet: Multi]

GT SoftGOT2000
For the communication interface of GT SoftGOT2000, refer to the following.
➟GT SoftGOT2000 Version1 Operating Manual
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➟GOT2000 Series User's Manual (Hardware)
For the system configuration of each controller and connection type, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

■2 How to set channels

(1) Setting with GT Designer3
Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears.

Select a channel No. to be used from the controller setting tree.
For the setting of channel No. 2 to 4, select a channel and the item shown as 1) below.

Step 3 Configure the communication settings for each channel.

➟5.5.1 ■4 [Controller Setting]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Channel No.

1)
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(2) Setting the channels with the parameter reflection function of MELSOFT Navigator
The system configuration of MELSOFT Navigator can be reflected to the project of GT Designer3 using the parameter 
function of MELSOFT Navigator.
For details of the parameter functions of MELSOFT Navigator, refer to the following.

➟Help of MELSOFT Navigator

(a) Items to be reflected from MELSOFT Navigator
The settings of the items in green cells are reflected from MELSOFT Navigator to the GOT project.
Set these items on MELSOFT Navigator.

(b) Connection with the devices which iQ Works does not support
Set [Set with GT Designer3] for the channel used for the connection with the devices which iQ Works does not support 
in [Input Detailed Configuration Information] of MELSOFT Navigator.
After the setting, set the communication interface in [Controller Setting] of GT Designer3.

(c) Permitting the editing of the items reflected from MELSOFT Navigator with GT Designer3
By performing the following setting, the items reflected from MELSOFT Navigator can be edited with GT Designer3.

Step 1 Select [Tools] → [Option] from the menu to display the [Option] dialog.
Step 2 Display the [iQ Works] tab.
Step 3 Select [Enable an editing of parameters set in MELSOFT Navigator].

If the items reflected from MELSOFT Navigator are edited, it makes the system configurations of the projects between 
GT Designer3 and MELSOFT Navigator mismatched.
Because of this mismatch, the interaction function with MELSOFT Navigator is disabled.
In this case, match the parameter setting of those projects using the parameter verification function before using the 
interaction function.
5 - 290 5. COMMON SETTING
5.5 Configuring the Communication Method between the GOT and the Controller ([Controller Setting])



5

C
O

M
M

O
N

 S
ET

TI
N

G

■3 Precautions

(1) Changing the channel after the device setting
Do not change the channel to an unused one in the controller setting after the device setting.
If the channel is changed to an unused one, the device of the unused channel must be set again.

(2) Setting the same channel number to access multiple networks
When you set the same channel number and communication driver to access two networks, if a communication timeout 
occurs in one network, the timeout also occurs in the other network.
To avoid a communication timeout from occurring in both networks, set a different channel number to access each 
network.

■4 [Controller Setting]

The settings in this window depend on the conditions, such as the controller model, communication interface, and 
communication driver used.
For the details of the settings, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

1) [Manufacturer]
Select the manufacturer of the controller connected to the GOT.

2) [Controller Type]
Select the model of the controller connected to the GOT.

➟12.2 Correspondence between the setting of [Controller Type] and the controller used
3) [I/F]

Select the communication interface of the GOT.
The selectable communication interfaces depend on the model of the GOT, controller, and connection type.
For the applicable communication interface for each GOT model, refer to the following.

➟5.5.1 ■1 Specifications of channels

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)

7)

5)

6)

4)

3)

4)
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4) [Driver]
Not available to GT SoftGOT2000.
This item appears when communication drivers are selectable according to the settings of [Controller Type] and [I/
F].
Select the communication driver to be written to the GOT.
Refer to the following to configure the setting.

➟GOT2000 Series Connection Manual for a controller used
5) [Detail Setting]

Set the connection details, such as the baud rate of the communication driver and the data length.
To display or hide the setting items, click the button at the left of [Detail Setting].
For the details, refer to the following.

➟12.15.5 [Detail Setting] dialog
6) [Connected Ethernet Controller Setting]

The list of the Ethernet setting on the controller registered in the project.
This list is displayed only for the Ethernet connection.
Each setting can be edited in the list.

Item Description

[Add] button Adds the Ethernet setting below the bottom row of the list.

[Delete] button Deletes a selected Ethernet setting.

[Duplicate] button Duplicates a selected Ethernet setting below the bottom row of the list.

[Copy] button Copies a selected Ethernet setting.

[Paste] button Pastes a copied Ethernet setting.

No.

Ethernet setting No.
Clicking an Ethernet setting No. selects the row.
To select multiple rows, perform one of the following operations.
Hold down the [Ctrl] key and click a setting No. To deselect a selected row, perform the same operation.
Select the first row in the range, hold down the [Shift] key, and click a setting No. to select the last row in the range.
For GT21 and GS21, configure the Ethernet settings in the range from [1] to [4].
Ethernet settings of [5] and later are invalid for GT21 and GS21.

[Host]
Selects a host station.
Asterisk (*) is displayed with the selected Ethernet setting.
For GT21 and GS21, set the host station number in the range from [1] to [4].

[Net No.] Set the network No. of the destination Ethernet module.

[Station] Select the station number of the destination Ethernet module.

[Unit Type]
Select the type of the destination Ethernet module.

➟12.5 [Unit Type] in [Connected Ethernet Controller Setting]

[IP Address]
Set the IP address of the controller.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

[Port No.] Set the port No. of the destination Ethernet module.

[FETCH Port No.]
Set the FETCH port No. of the destination Ethernet module.
This item is displayed only when [Ethernet(SIEMENS S7), Gateway] is selected for [Driver].

[WRITE Port No.]
Set the WRITE port No. of the destination Ethernet module.
This item is displayed only when [Ethernet(SIEMENS S7), Gateway] is selected for [Driver].

[Connection No./Rack No.]
Set the connection No. or rack No. of the destination Ethernet module.
This item is displayed only when [Ethernet(SIEMENS OP), Gateway] is selected for [Driver].

[Add] button
[Delete] button
[Duplicate] button
[Copy] button
[Paste] button

No.
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7) [New]
Double-click this item to add a new Ethernet setting row to the bottom of the list of [Connected Ethernet Controller 
Setting].

■5 [GOT (Extend Computer)] dialog

In this dialog, set the interface for connecting multiple GOTs by the microcomputer connection (serial).
To display this dialog, select [Common] → [Peripheral Setting] → [GOT (Extended Computer)] from the menu.

1) [Destination I/F]
Select the interface for the connection to the GOT (Extended Computer).
The following shows the setting range.
For GT2107-W, GT2105-Q, GT2104-R, and GS21

• [Standard I/F(RS422/485)]
• [Standard I/F(RS232)]
• [Not connected]

For GT2104-P and GT2103-P
• [Standard I/F(RS422/485/232)(Side)]
• [Standard I/F(RS232(Back))]
• [Not connected]

2) [Detail Setting]
Set the details for the connection to the GOT (Extended Computer).

■6 [Controller Type List] window

The window displayed to confirm the controllers of each channel.
Select [View] → [Docking Window] → [Controller Type List] from the menu to display the window.

[Module Position/Slot No.]
Set the module position or slot No. of the destination Ethernet module.
This item is displayed only when [Ethernet(SIEMENS OP), Gateway] is selected for [Driver].

[Communication]

Displays the communication protocol corresponding to the setting of [Port No.].
Select a communication protocol.
The following shows the items to be selected.
• [UDP]
• [TCP]

[Connection]

Set the message communication type according to that of the connected controller.
This item is displayed only when [Ethernet(AB Tag), Gateway] is selected for [Driver].
The following shows the items to be selected.
• [UCMM]
• [Class3]

[Slot No.]

Set the slot No. of the PLC to which the Ethernet module is installed.
This item is displayed only when one of the following items is selected for [Driver].
• [[Ethernet(AB), Gateway]
• [Ethernet(AB Tag), Gateway]

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.5.2 Setting the routing information

➟■1 Specifications of the routing information
■2 How to set the routing information
■3 [Routing Information]

Use the routing information to specify the destination network and the network to be routed when monitoring the controller 
on a different network with either of the following connection types.

• Ethernet connection
• MELSECNET/H connection
• CC-Link IE TSN connection
• CC-Link IE Controller Network connection
• CC-Link IE Field Network connection
• SLMP connection

If the communication is performed within the host station, the routing information setting is not required.

■1 Specifications of the routing information

For the details of the routing parameter, refer to the following.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Network No.3Network No.2Network No.1

NetNo.1
Station No. 1

NetNo.2
Station No.1

NetNo.3
Station No.1 

Routing information
                           of the GOT
   Destination network: No.3
   Relay network: No.1
   Relay station: No.2

Routing information
            of relay station No.1
   Destination network: No.3
   Relay network: No.2
   Relay station: No.2

Routing information
            of relay station No.2
   Destination network: No.1
   Relay network: No.2
   Relay station: No.1

Routing information
           of the monitor target
   Destination network: No.1
   Relay network: No.3
   Relay station: No.1

Net No.1
Station No.2

(Relay station No.1 )

Net No.3
Station No.2

(Monitor target)

Net No.2
Station No.2

(Relay station No.2)

Relay station device Reference manual

RCPU ➟MELSEC iQ-R CPU Module User's Manual (Application)

Other than 
RCPU

Ethernet connection ➟MELSEC-Q/L Ethernet Interface Module User's Manual (Application)

MELSECNET/H connection ➟Q Corresponding MELSECNET/H Network System Reference Manual (PLC to PLC 
network)

CC-Link IE Controller Network connection ➟MELSEC-Q CC-Link IE Controller Network Reference Manual

CC-Link IE Field Network connection ➟MELSEC-Q CC-Link IE Field Network Master/Local Module User's Manual

SLMP server device ➟Manual of the SLMP-compatible device used

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 How to set the routing information

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears.

Select the [Routing Information] menu from the controller setting tree.

Step 3 Configure the routing information setting for each channel.
Select the tab of the channel for which the routing information is set.

After selecting the tab, set the routing information.
➟5.5.2 ■3 [Routing Information]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Routing Information] 
menu

Channel No. 
tab
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■3 [Routing Information]

1) List of routing information settings
Lists the routing information settings registered in the project.
Each setting can be edited in the list.

*1 When the communication driver is set to [Ethernet(SLMP), Gateway], the settable values are [0] to [120], and [125].
2) Buttons for the routing information setting

Use the following buttons to add, copy, and delete the routing information setting in the list.

Item Description

[Transfer Net No.] Set the network No. of the destination network. The setting range is [1] to [239].

[Relay Net No.] Set the network No. of the relay network. The setting range is [1] to [239].

[Relay Station No.] Set the station number of the relay station. The setting range is [0] to [120].*1

Item Description

[New] Adds the routing information setting below the bottom row of the list.

[Duplicate] Duplicates a selected routing information setting below the bottom row of the list.

[Delete] Deletes a selected routing information setting.

[Delete All] Deletes all the routing information settings.

[Copy All]
Copies all the routing information settings in the list of the selected tab.
Use this button to utilize the settings for other channels.

[Paste All]
Pastes the copied settings to the list.
The existing settings are overwritten.

[Check]

Checks if the routing information setting has any error.
The following show the points to be checked.
• Non-entered items
• Setting range
• Duplication of the destination network numbers

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)1)
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5.5.3 Configuring the setting of the MELSEC redundant function

➟■1 How to set the MELSEC redundant function
■2 Precautions
■3 [MELSEC Redundant]

You can monitor the redundant system on the GOT by specifying the control system and the standby system.
If the redundant system is the target station, specifying the control system as the target CPU enables consecutive 
monitoring even when the system is switched from the control system to the standby system.
For the details of the redundant system, refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

■1 How to set the MELSEC redundant function

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears.

Select [MELSEC Redundant] from the setting tree.

Step 3 Configure the MELSEC redundant setting by channel.
Select the target channel tab, and configure the MELSEC redundant setting.

➟5.5.3 ■3 [MELSEC Redundant]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

EthernetEthernet

Standby system

Monitor target

Down
System 
switching

Follows the 
system switching.

Monitor target

Standby system
Control 
system

Control 
system

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[MELSEC Redundant]
menu 

Channel No. 
tab
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(1) Display of the standby system device
The following shows the display example of a device of the standby system.

To delete [-S], use the [Network Batch Edit] dialog or other methods.
➟11.8.4 ■5 [Network Batch Edit] dialog

■2 Precautions

(1) Canceling the specification of a standby system device and the redundant setting
When you specify a device of the standby system, even if you clear [Use the function of MELSEC Redundant], the 
specified device is still marked with [-S] that identifies the standby system.
When you utilize such a device setting, change the device as shown below.

To delete [-S], use the [Network Batch Edit] dialog or other methods.
➟11.8.4 ■5 [Network Batch Edit] dialog

[-S] is displayed for a device of the standby system.
[-S] is not displayed for a device of the control system.

1-1/1-S W0.b0

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

To use this device as a 
control system device, 
delete [-S].

1-1/1-S W0.b0

Display example of the 
standby system device

Display example of the 
control system device

1-1/1 W0.b0
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■3 [MELSEC Redundant]

1) [Use the function of MELSEC Redundant]
Enables the MELSEC redundant function.
Select this item to set each item in [MELSEC Redundant].

2) [Follow the redundant system via a serial interface.]
Automatically switches the monitoring target upon system switching if the redundant system is connected to the 
GOT by the serial connection.

3) MELSEC redundant setting list
Lists the MELSEC redundant settings registered in the project.
Each setting can be edited in the list.

*1 Setting [Pair No.] is not required to monitor the redundant system that is connected to the GOT by the CC-Link connection 
(intelligent device station).

4) Operation buttons for the MELSEC redundant setting list
Add, copy, and delete a MELSEC redundant setting in the list.

Item Description

[Pair No.] *1 Pair number of the MELSEC redundant setting The numbers are assigned automatically 
starting from 1.

[Net No.]

Set the network Nos. for each pair No.
The upper row is for the setting of the first redundant CPU.
The setting range is [1] to [239].
The lower row is for the setting of the second redundant CPU.
The network No. of the second redundant CPU is the same as the one for the first CPU.

[Station No.]

Set the station numbers of the redundant CPUs for each pair No.
The upper row is for the setting of the first redundant CPU.
The setting range is [0] to [120].
The lower row is for the setting of the second redundant CPU.
The setting range is [0] to [120].

Item Description

[New] Adds the pair No. setting below the bottom row in the list.

[Duplicate] Duplicates a selected pair No. setting below the bottom row in the list.

[Delete] Deletes a selected pair No. setting.

[Delete All] Deletes all the pair No. settings.

[Copy All]
Copies all the pair No. settings in the list of the selected tab.
Use this button to utilize the settings for other channels.

[Paste All]
Pastes the copied settings to the list.
The existing settings are overwritten.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
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5.5.4 Configuring the settings for switching the target station No. for monitoring

➟■1 Specifications of the station No. switching setting
■2 How to use the station No. switching setting
■3 [Station No. Switching]
■4 Relevant settings

The station numbers of the monitor target devices can be switched by using the station No. switching.
Multiple devices can be monitored through a single monitor screen in the system to which the devices executing the same 
control to the network are connected.
(You do not have to create the monitor screens as many as the number of devices.)
Since the number of objects to be set can be reduced, you can save the built-in memory of the GOT.

The station No. switching is available for the stations that can be monitored by the GOT.
For the stations that can be monitored by the GOT (accessible range), refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Product qty

50

Network No. 2

Station No.2
Product qty

20

Network No. 2

Station No.2
Station No. 

switching device
D500: 020Ah

Station No. 
switching device

D500: 0200h

Monitoring D100 of the master station Monitoring D100 whose station No. is 10

Station
 No.10

Station 
No. 0

(Master 
station)

Station 
No. 0

(Master 
station)

Product qty
D100：20

Line A

Product qty
D100：50

Line B
Monitor target

Station
 No.10

Product qty
D100：20

Line A

Product qty
D100：50

Line B
Monitor target
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■1 Specifications of the station No. switching setting

(1) Communication drivers supporting the station No. switching
The following lists the communication drivers that the station No. switching can be used.
If one controller can be connected to one GOT, the station No. switching cannot be used even though any of the following 
drivers.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Manufacturer
Communication protocol Communication driver Communication type

MITSUBISHI ELECTRIC

[MELSECNET/H] MELSECNET/H

[CC-Link IE TSN] CC-Link IE TSN

[CC-Link IE Controller Network] CC-Link IE Controller Network

[CC-Link Ver.2(ID)] CC-Link Ver.2(ID)

[Ethernet(MITSUBISHI ELECTRIC), Gateway]

Ethernet

[Ethernet(FX), Gateway]

[Ethernet(FREQROL), Gateway]

[Ethernet(FREQROL(Batch monitor)), Gateway]

[Ethernet(MELSERVO), Gateway]

[FREQROL 500/700/800, SENSORLESS SERVO]

RS-485[FREQROL 800]

[FREQROL(Batch monitor)]

IAI [IAI ROBO CYLINDER]
RS-232
RS-422/485

AZBIL
[Azbil SDC/DMC] RS-232

RS-485[Azbil DMC50]

OMRON

[Ethernet(OMRON), Gateway] Ethernet

[OMRON THERMAC/INPANEL NEO] RS-232
RS-422
RS-485[OMRON Digital Temperature Controller]

KEYENCE [Ethernet(KEYENCE), Gateway] Ethernet

KOYO EI [KOYO KOSTAC/DL]
RS-232
RS-422

JTEKT [JTECT TOYOPUC-PC]
RS-232
RS-422

SHINKO [SHINKO TECHNOS CONTROLLER]
RS-232
RS-485

CHINO [CHINO MODBUS device]
RS-232
RS-422
RS-485

TOSHIBA [Ethernet(TOSHIBA nv), Gateway] Ethernet

PANASONIC
[Panasonic MINAS A4] RS-232

RS-485[Panasonic MINAS A5]

HITACHI [Ethernet(HITACHI), Gateway] Ethernet

FUJI

[Ethernet(FUJI), Gateway] Ethernet

[FUJI Temperature Controller/Digital Controller]
RS-232
RS-485

YASKAWA
[Ethernet(YASKAWA), Gateway]

Ethernet
[Ethernet(YASKAWA MP3000), Gateway]

YOKOGAWA

[Ethernet(YOKOGAWA), Gateway] Ethernet

[YOKOGAWA GREEN/UT100/UT2000/UT Advance]
RS-232
RS-485
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(2) Functions supporting the station No. switching

○: Supported , ×: Unsupported

RKC [RKC SR Mini HG(MODBUS)]
RS-232
RS-422
RS-485

ALLEN-BRADLEY
[Ethernet(AB MicroLogix), Gateway]

Ethernet
[Ethernet(AB), Gateway]

GE [GE (SNP-X)]
RS-232
RS-422

SIEMENS [Ethernet(SIEMENS S7), Gateway] Ethernet

MODBUS

[MODBUS/TCP Master, Gateway] Ethernet

[MODBUS/RTU Master]
RS-232
RS-422/485

SLMP [Ethernet(SLMP), Gateway] Ethernet

Manufacturer
Communication protocol Communication driver Communication type

Function name Station No. switching Remarks

Touch switch ○ Indirect devices are also the targets of the station No. switching.

Numerical Display ○ -

Numerical Input ○ -

Text Display ○ -

Text Input ○ -

Comment Display ○ -

Lamp ○ -

Parts Display ○ -

Parts Movement ○ -

Scatter Graph ○ The station No. switching is not supported when the memory storage is 
used.

Statistics Graph ○ -

Line Graph ○ -

Trend Graph ○
Logging devices are not the targets of the station No. switching.

Historical Data List Display ○

Bar Graph ○ -

Graphical meter ○ -

Panelmeter ○ -

Level ○ -

Slider ○ -

Alarm Observation × -

Alarm Display ○ The station No. switching is not supported when the alarm popup display 
is used.

Recipe display (record list) ○ -

Recipe × -

Logging × -

Project script × -

Screen script ○ -

Script parts ○ -

Object script ○ -

Status observation (project) × -

Status observation (screen) ○ Trigger devices and offset devices are the targets of the station No. 
switching.
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(3) The channels compatible with the station No. switching
The station No. switching can be set for all the channels (CH1 to CH4).
For the setting procedure, refer to the following.

➟5.5.4 ■3 [Station No. Switching]

(4) Applicable range of the station No. switching
Select whether to use the station No. switching in the whole project or for each screen.
If you use the station No. switching in the whole project, set the station No. switching device to be used.
If you select whether to use the station No. switching or not for each screen, set the station No. switching device for each 
screen type.
After that, set whether to use the station No. switching or not for every screen.
For each setting procedure, refer to the following.

➟5.5.4 ■3 [Station No. Switching]
　 2.7.1 ■1 [Basic] tab
　 2.7.2 ■1 [Basic] tab

(5) Stored value of the station No. switching device
Use a word device whose data type is the unsigned BIN16 as the station No. switching device.
When the station No. switching is executed, the value to be stored in the station No. switching device differs depending 
on the system configuration of the monitor target.

(a) Data link system (MELSECNET/B, (II)), CC-Link system

(b) Network system (MELSECNET/H, MELSECNET/10), Ethernet system, CC-Link IE TSN system, CC-
Link IE Controller Network system, CC-Link IE Field Network system

Operation Log × -

Document Display ○ -

Video/RGB Display × -

MES interface function × -

Time action × -

Trigger action (project) × -

Trigger action (screen) ○ -

Device Data Transfer × -

Language switching × -

System language switching × -

Screen switching × -

System information × -

Function name Station No. switching Remarks

Switching target Storage value (hexadecimal)

Master station 0000h

Local station (1 to 64) 0001h to 0040h

Station No. set for each object (The monitor target which is the same as the one 
set if the station No. switching has not been set is used.) 00FEh

Host station (connection target) 00FFh

Switching target Storage value (hexadecimal)

Network No. (1 to 255) The following shows the relation between the switching targets 
and the storage values.
• Upper 8 bits: Network No.
• Lower 8bits: Station number
Example) Network No.: 1, PLC station No.: 18

PLC station No. (1 to 255)

Station No. set for each object (The monitor target which is the same as the 
one set if the station No. switching has not been set is used.) 00FEh

0 1 1 2 h

Network No.
Station No.
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(6) Using an internal device (GD) as the station No. switching device
The GOT starts monitoring the module connected to the station No. 0 of the network No. 0 from right after the GOT is 
powered on until the value of the station No. switching device (GD) is set.
In this case, a system alarm due to the communication timeout may occur depending on the connection type.
To avoid the occurrence of the system alarm, create an initially-displayed screen with no object and set the station No. 
switching device (GD) and its value on the screen.

(7) Touch switches, trigger action function, and script function operating in the destination station
To execute the actions of touch switches, the trigger action function, and the script function by using the devices of the 
destination station after the station No. switching, select [Include touch switch action, trigger action (screen), and script 
(screen) for Station No. Switching].
If [Include touch switch action, trigger action (screen), and script (screen) for Station No. Switching] is not selected, each 
object operates as follows.

(8) Redrawing the screen after the station No. switching
The screen objects are redrawn immediately after the station No. switching.
Thus, the display speed of the object may become slow temporarily.

(9) Switching the station No. during the input operation
When using the numerical input or text input, switch the station number after the completion of the input operation.
If the station No. is switched during the input operation, the data may not be written to the monitored device correctly. To 
write the station No. from the controller to the station No. switching device, use the Key Window Output signal (System 
signal 2-1.b11) after the completion of the input operation.
The Key Window Output signal is on while the key window is displayed.

(10)Station No. switching while a dialog window is displayed
The dialog window operates according to the value of the station No. switching device which is set when the dialog 
window is displayed.
If the value of station No. switching device is changed while the dialog window is displayed, the display and operation of 
the object on the dialog window are not changed.
(The devices of the objects are the same as the device before the station No. switching.)

(11)Station No. switching for each object
The functions for which the station No. switching cannot be executed operate with the device whose station number is 
set by each function.
If the objects which are not compatible with the station No. switching are placed on the same screen where the objects 
compatible with the station No. switching are placed, note that the different station numbers are monitored for each object.

Host station (connection target) 00FFh

Switching target Storage value (hexadecimal)

Object Target device Monitor target

Touch switch

The device to specify the display status of the ON/OFF 
figure Device of the destination station after the station No. 

switching
The device to specify a comment of the comment text

The device of the monitor target The device whose station No. was set in GT Designer3

Trigger action (screen)
Trigger device The device whose station No. has been switched

Actions for when the condition is satisfied The device whose station No. was set in GT Designer3

Script (screen)

Screen script, object script
The device whose station No. has been switched

Script function (monitor device)

Script function (write device) The device whose station No. was set in GT Designer3
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■2 How to use the station No. switching setting

(1) How to switch the station numbers
Switch the station numbers with either of the following methods.

• Station No. switching with the station No. switching device
By storing the value which indicates the switching target in the station No. switching device, the station No. switching 
is executed.
For the storage values of the station No. switching devices, refer to the following.

➟5.5.4 ■1 Specifications of the station No. switching setting
• Station No. switching with touch switches (Change Station No. Switch)

Touching the touch switch for which the station No. switching is set executes the station No. switching.
In this case, the setting of the station No. switching device is required.
For the setting of touch switches, refer to the following.

➟8.2.8 [Change Station No. Switch] dialog

(2) Setting procedure
Step 1 When executing the station No. switching for each screen, select [Switch Station No.] in the property of the 

each screen for which the station No switching is executed.

➟2.7.1 ■1 [Basic] tab
　 2.7.2 ■1 [Basic] tab

Step 2 Select [Common] → [Controller Setting] from the menu.
Step 3 The [Controller Setting] window appears.

Select the [Station No. Switching] menu from the controller setting tree.

Step 4 Select [Use station No. Switching].

After selecting [Use station No. Switching], configure the settings of the station No. switching.
➟5.5.4 ■3 [Station No. Switching]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Station No. Switching] 
menu

[Use station No. Switching]
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■3 [Station No. Switching]

1) [All]
The station No. switching is executed to the whole project.
After selecting [All], set the station No. switching device.
Word devices whose data types are unsigned BIN 16 can be used as the station No. switching devices.

2) [Screen Type]
The station No. switching is applied for each screen type.
After the selection of [Screen Type], select the screen type to be switched the station No., and set the station No. 
switching device.
Word devices whose data types are unsigned BIN 16 can be used as the station No. switching devices.

3) [Include touch switch action, trigger action (screen), and script (screen) for Station No. 
Switching]
Sets the devices of touch switches, trigger actions (per screen), and screen scripts as the target of station No. 
switching.
For details, refer to the following.

➟5.5.4 ■1 (7) Touch switches, trigger action function, and script function operating in the destination station
4) [CH No. for Station No. Switching]

Selects the channel No. for which the station No. switching is executed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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■4 Relevant settings

Set the relevant settings other than the specific settings for the station No. switching function as required.
The following shows the functions that are available by the relevant settings.

(1) Property of screens
The property can be set for each screen.
Select the screen editor on which the key window is to be set and select [Screen] → [Display Properties] from the menu 
to display the [Screen Property] dialog.

➟2.7.1 ■1 [Basic] tab
　 2.7.2 ■1 [Basic] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Setting whether to execute the station No. switching or not for each 
screen Select [Switch Station No.] from in the [Basic] tab
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5.5.5 Configuring the settings for switching the buffer memory unit No. of the 
monitoring target

➟■1 Specifications of the buffer memory unit No. switching
　 ■2 How to use the buffer memory unit No. switching
　 ■3 Precautions
　 ■4 [Buffer Memory Unit No. Switching]
　 ■5 Relevant settings

The GOT switches the buffer memory unit No. of the monitoring target by using the buffer memory unit No. switching 
device.
For systems in which multiple machines performing the same control are connected to a network, the number of monitor 
screens is unnecessary to match with that of machines. You can monitor the multiple machines on one monitor screen 
by switching the buffer memory unit No.
Since the number of objects to be set can be reduced, you can save the built-in memory space of the GOT.
You can perform the buffer memory unit No. switching to the buffer memory that can be monitored by the GOT.
For the buffer memory that can be monitored by the GOT (accessible range), refer to the following.

➟12.4Device Range and Settings of Each Controller
The GOT monitors the machine corresponding to the value stored in the buffer memory unit No. switching device.
Upon the buffer memory unit No. switching, the GOT redraws displayed figures and objects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Buffer memory unit No. 
switching device

D10
(hex)

Production 
volume

Monitoring buffer 
memory unit 1

Production 
volume

Switching the monitoring 
target to buffer memory 
unit 2

Changing the value of the 
buffer memory unit No. 
switching device to monitor 
buffer memory unit 2

Monitoring BM0 
of module 1

Monitoring BM0 
of module 2

40

100

Line B

Line A

Production volume: 40

Line B

0001

Buffer memory unit No. 
switching device

D10
(hex)

0002

Production volume: 100

Line A

Module 1

Module 2
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■1 Specifications of the buffer memory unit No. switching

(1) Controllers supporting the buffer memory unit No. switching
The following shows the controllers supporting the buffer memory unit No. switching.

(2) Functions supporting the buffer memory unit No. switching

○ : Supported , ×: Unsupported

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Type Controller

PLC, CNC, C Controller module, motion controller, 
robot controller, MELIPC

MELSEC iQ-R series, MELSEC iQ-F, MELSEC-Q, MELSEC-QS, MELSEC-L, MELSEC-QnA, 
MELSEC-A, C Controller module, Motion CPU (MELSEC iQ-R series), Motion CPU (Q series), 
Motion CPU (A series), CNC C70, robot controller CRnQ-700, MELIPC

Function name Buffer memory unit No. 
switching Remarks

Touch switch ○
Indirect devices are also subject to the buffer memory unit No. 
switching. Screen switching devices and station No. switching devices 
are not subject to the buffer memory unit No. switching.

Numerical display ○ -

Numerical input ○ -

Text display ○ -

Text input ○ -

Comment display ○ -

Lamp ○ -

Parts display ○ -

Parts movement ○ -

Clock display × -

Scatter graph ○ The buffer memory unit No. switching cannot be executed when the 
memory storage is used.

Statistics graph ○ -

Line graph ○ -

Trend graph ○ Logging devices are not subject to the buffer memory unit No. 
switching.Historical data list display ○

Bar graph ○ -

Graphical meter ○ -

Panelmeter ○ -

Level display ○ -

Data list display ○ -

Slider ○ -

Alarm observation × -

Alarm display ○ The buffer memory unit No. switching cannot be executed in the alarm 
popup display.

Recipe display (record list) ○ -

Recipe × -

Logging × -

Project script × -

Screen script ○ -

Script parts ○ -

Object script ○ -

Status observation (project) × -

Status observation (screen) ○ -

Operation log × -
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(3) Applicable range of the buffer memory unit No. switching
You can select whether to use the buffer memory unit No. switching in the whole project or for each screen.
To use the buffer memory unit No. switching in the whole project, set the buffer memory unit No. switching device to be 
shared.
To select whether to use the buffer memory unit No. switching for each screen, set the buffer memory unit No. switching 
device by screen type.
Additionally, set whether to use the buffer memory unit No. switching for every screen in the screen property.
For each setting procedure, refer to the following.

➟5.5.5 ■4 [Buffer Memory Unit No. Switching]
　 2.7.1 ■1 [Basic] tab
　 2.7.2 ■1 [Basic] tab

(4) Data type of the buffer memory unit No. switching device
Use a word device whose data type is unsigned BIN16 as the buffer memory unit No. switching device.

(5) Judgment of communication status
When you attempt to switch the buffer memory unit No. to a nonexistent one, the switching is not executed and the buffer 
memory unit No. switching device stores -1.
This enables you to judge the communication status (normal or abnormal) of the buffer memory unit.
When you monitor a buffer memory that always stores a value other than -1, if the buffer memory stores -1, the 
communication status is abnormal.
When a value other than -1 is stored, the communication status is normal.
Example)
For G0 (basic parameter 1) of QD74MH8, the device value ranges from 0 to 3. If G0 stores -1, the communication status 
is abnormal.

Document display ○ -

Video/RGB display × -

MES interface function × -

Time action × -

Trigger action (project) × -

Trigger action (screen) ○ Devices set on the destination screen are not subject to the buffer 
memory unit No. switching.

Device data transfer × -

Language switching × -

System language switching × -

Screen switching × -

System information × -

Function name Buffer memory unit No. 
switching Remarks
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■2 How to use the buffer memory unit No. switching

(1) How to switch buffer memory unit numbers
The buffer memory unit No. switching is executed by storing a value, which indicates the switching destination, in the 
buffer memory unit No. switching device.
The buffer memory unit No. switching device stores a value whose data type is unsigned BIN16.

(2) Setting procedure
Step 1 To execute the buffer memory unit No. switching by screen, select [Switch buffer memory unit No.] in the 

property of each screen on which the buffer memory unit No. switching is executed.

➟2.7.1 ■1 [Basic] tab
　 2.7.2 ■1 [Basic] tab

Step 2 Select [Common] → [Controller Setting] from the menu.
Step 3 In the [Controller Setting] window, select the [Buffer Memory Unit No. Switching] menu from the controller 

setting tree.
Step 4 Select [Use the function of buffer memory unit No. switching].

Then, configure the settings for the buffer memory unit No. switching.
➟5.5.5 ■4 [Buffer Memory Unit No. Switching]

■3 Precautions

(1) Buffer memory unit No. switching in dialog windows
For dialog windows, the GOT obtains the value stored in the buffer memory unit No. switching device when a dialog 
window is opened.
While a user-created dialog window is being displayed, even if the value of the buffer memory unit No. switching device 
is changed, the buffer memory unit No. switching is not executed.

(2) Operation when the buffer memory unit No. switching is disabled
In the following cases, the GOT cannot execute the buffer memory unit No. switching and monitors the buffer memory 
unit No. set in the device setting of each object.

• The value of the buffer memory unit No. switching device is outside the range.
• The GOT cannot monitor the buffer memory unit to be switched to due to communication errors, such as a cable 

disconnection.
• The buffer memory unit No. to be switched to is outside a range of 0x00 to 0xFF.

After the GOT startup, if the GOT cannot monitor the buffer memory unit to be switched to due to communication errors, 
such as a cable disconnection, the GOT switches back to monitor the buffer memory unit last monitored.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3.

4.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Buffer Memory Unit No. Switching]

1) [All]
Enables the buffer memory unit No. switching in the whole project.
Select this item, and then set the buffer memory unit No. switching device.
Word devices whose data types are unsigned BIN16 are usable.

2) [Screen Type]
Enables the buffer memory unit No. switching by screen type.
Select this item, select the type of screens in which the buffer memory unit No. switching is performed, and then 
set the buffer memory unit No. switching device and others.

Item Description

[Specify the target unit No.] Set the buffer memory unit No. to be switched.

Item Description

[Screen Type] Select a screen in which the buffer memory unit No. switching is performed.

[Device]
Set the buffer memory unit No. switching device.
Word devices whose data types are unsigned BIN16 are usable.

[Target]
Set whether to specify the selected screen as the switching target.
Select this item, and then set the buffer memory unit No. to be switched in [Unit No.].

[Unit No.] Set the buffer memory unit No. to be switched.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■5 Relevant settings

Set the relevant settings other than the specific settings for the buffer memory unit No. switching function as required.
The following shows the functions that are available by the relevant settings.

(1) Property of screens
The property can be set for each screen.
Select the screen editor on which the key window is to be set and select [Screen] → [Display Properties] from the menu 
to display the [Screen Property] dialog.

➟2.7.1 ■1 [Basic] tab
2.7.2 ■1 [Basic] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Setting whether to execute the buffer memory unit No. switching by 
screen [Switch buffer memory unit No.] on the [Basic] tab
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5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT 
Network Interaction])

➟5.6.1 Specifications of the GOT network interaction function
5.6.2 How to use the GOT network interaction function
5.6.3 Precautions
5.6.4 [GOT Network Interaction] dialog

The GOT network interaction function controls the authorization (operational authority) among pieces of equipment on 
the same network to prevent simultaneous operations.

An authorization control group is formed consisting of such pieces of equipment. In the group, a GOT is specified as the 
master GOT to control the authorization.
The other pieces of equipment in the group communicate with the master GOT to obtain the authorization.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet

GOT2GOT1

Authorized

Writing data to a device

GOT3

PLC CPU

Ethernet

(Master GOT)
Tablet

(GOT Mobile function client)
GOT

GOT

Personal computer
(VNC client)

Personal computer
(GT SoftGOT2000)
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5.6.1 Specifications of the GOT network interaction function

➟■1 Target equipment
■2 Authorization control scope
■3 Target screen
■4 Influences on other functions
■5 Required system application (extended function)

■1 Target equipment
The following equipment types are applicable to the authorization control when the GOT network interaction function is 
used.
• Master GOT: Equipment that controls authorization.
• Operator device: Equipment that requests for authorization and obtains it from the master GOT.

The recommended number of operator devices is as follows.
• When the master GOT is a GOT: Up to 7 operator devices per 1 master GOT
• When the master GOT is GT SoftGOT2000: Up to 15 operator devices per 1 master GOT

The following shows the applicable equipment types.
○ : Applicable, - : Not applicable

■2 Authorization control scope
You can enable the authorization control for pieces of equipment when the following requirements are satisfied.

• The pieces of equipment are on the same subnet.
• The same master GOT is specified for the pieces of equipment.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Operator device Master GOT

GT27 ○ ○

GT25, GS25 ○ ○

GT23 ○ -

GT SoftGOT2000 ○ ○

GT SoftGOT2000 (when the SoftGOT-GOT link function is used) ○ -

VNC client (VNC server function) ○ -

Client (GOT Mobile function) ○ -

Ethernet

IP address: 192.168.4.18 IP address: 192.168.4.20

Equipment in the authorization control scope

Equipment: 192.168.3.18
Master GOT: 192.168.3.18

IP address

Equipment: 192.168.3.19
Master GOT: 192.168.3.18

IP address

Equipment: 192.168.3.20
Master GOT: 192.168.3.18

IP address
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■3 Target screen
You can set whether the authorization is required to operate objects on a screen by screen basis.
The following shows the target screens for the authorization control.

• Base screen
• Window screen (when displayed as a superimpose window or overlap window)
• Mobile screen

When the authorization control is enabled in a screen, the applicable equipment needs the authorization to operate the 
objects on the screen.
If unauthorized equipment displays such a screen, the objects on the screen are not operable.
When the authorization control is disabled in a screen, the applicable equipment does not need the authorization to 
display the screen and operate the objects or the utility call key on the screen.
If the authorization control is enabled in some screens and disabled in others, the setting of each screen determines 
whether to activate the authorization control.
Example) Availability of operation on unauthorized equipment

• Base screen (Basic screen of the set overlay screen function): The authorization control is enabled.
• Superimpose window: The authorization control is enabled.
• Overlap window: The authorization control is disabled.
• Called screen (Screen called from the base screen): The authorization control is disabled.

■4 Influences on other functions
Enabling the GOT network interaction function influences other functions as follows.

■5 Required system application (extended function)
Not available to GT SoftGOT2000.
To use the GOT network interaction function, a system application (extended function) of [GOT Network Interaction] is 
required.
Selecting [Use GOT network interaction function] in the [GOT Network Interaction] dialog incorporates the application into 
package data automatically.

➟5.6.4 [GOT Network Interaction] dialog

Superimpose window

Overlap window

Called screen

Objects are operable.
Objects are not operable.

Base screen 

(basic screen)

Objects are not operable. Objects are operable.

Function Influence

SoftGOT-GOT Link Function

The authorization control of the SoftGOT-GOT link function becomes disabled. The authorization control of the 
GOT network interaction function becomes enabled.
Multiple GT SoftGOT2000 modules are connectable to one GOT.
In this case, each GT SoftGOT2000 module must be run on different personal computers. If multiple modules of 
GT SoftGOT2000 are run on one personal computer, the modules cannot connect to the same GOT 
simultaneously.
The popup display of the GOT network interaction function is applied to the GT SoftGOT2000 or GOT screen.
➟GT SoftGOT2000 Version1 Operating Manual

VNC Server Function

Even though the GOT network interaction function is enabled, the authorization control of the VNC server function 
remains active.
To operate a screen in which the authorization control is enabled, the VNC server or VNC client requires the 
authorization from both the GOT network interaction function and the VNC server function. (When you perform 
operations on the VNC client, the VNC server obtains the authorization of the GOT network interaction function.)
The popup display of the GOT network interaction function is applied to the VNC server or VNC client screen.
➟10.5 Viewing the GOT from a Personal Computer (VNC Server Function)

GOT Mobile function
To operate a screen in which the authorization control is enabled, the client requires the authorization from the 
GOT network interaction function.
➟10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)
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5.6.2 How to use the GOT network interaction function

➟■1 Setting on GT Designer3
■2 Settings in GT SoftGOT2000
■3 Operation on target equipment
■4 Authorization control and status notification with devices

■1 Setting on GT Designer3
Configure the following setting in all the projects of the GOTs that are under control of the GOT network interaction 
function.

Step 1 Select [Common] → [GOT Network Interaction] from the menu to display the [GOT Network Interaction] 
dialog.

➟5.6.4 [GOT Network Interaction] dialog
Step 2 Set the following items, and click the [OK] button.

• Select [Use GOT network interaction function].
• Set the IP address of the master GOT in [IP address].

Set the following items if necessary.
• [Port No.]
• [Guaranteed time of operational authority after the last operation]
• [Specify the home screen No.]

Step 3 To enable the authorization control for a screen, select [Target for exclusive control of operational authority] 
in the [Basic] tab in the [Screen Property] dialog.

➟2.7 Changing Screen Property
To collectively enable or disable the authorization control for all the base screens and window screens, 
configure the setting in the [GOT Network Interaction] dialog.
To collectively enable or disable the authorization control for all the mobile screens, configure the setting in 
[Exclusive Control of Operational Authority] in the [GOT Mobile Setting] window.

■2 Settings in GT SoftGOT2000
To use GT SoftGOT2000 as the master GOT, configure the following settings in GT SoftGOT2000.

Step 1 Select [Online] → [Communication Setup] from the menu.
Step 2 In the [GOT Network Interaction Function] tab in the [Communication Setup] dialog, configure the following 

settings.
• [Control authorization using GT SoftGOT2000 (this module)]: Select this item.
• [IP address]: Set the IP address of GT SoftGOT2000 (master GOT).
• [Port No.]: Set the port number of GT SoftGOT2000 (master GOT).
For details, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Operation on target equipment
On unauthorized equipment, when you switch a screen to another screen in which the authorization control is enabled, 
the equipment is automatically authorized if no equipment in the control group holds the authorization. The popup display 
appears on the applicable equipment.
On the popup display, you can check the authorization status, and manually grant or release the authorization.
For the details of operations and the differences by equipment, refer to the following.

➟(1) Obtaining the authorization
(2) Releasing the authorization
(3) Operation on the popup display

You can also use GOT internal devices to check the authorization status and control the authorization, such as prohibiting 
equipment from obtaining it.

➟5.6.2 ■4 Authorization control and status notification with devices

(1) Obtaining the authorization
On unauthorized eqiupment, when you switch a screen to another screen in which the authorization control is enabled, 
the equipment tries to obtain the authorization.
The screen is switched regardless of whether the equipment obtains the authorization.
To manually grant the authorization to equipment, touch the status icon on the popup display.
To grant the authorization of the VNC server function to the VNC server or VNC client, touch the message display area 
on the popup display.

➟(3) Operation on the popup display
When the set overlay screen function is used, the behavior of obtaining the authorization differs depending on the setting 
of the destination basic screen.

For the details of the set overlay screen function, refer to the following.
➟8.29 Placing Another Screen on a Screen

(2) Releasing the authorization
On the authorized equipment, when you switch a screen to another screen in which the authorization control is disabled, 
the equipment automatically releases the authorization. (Note that the authorization is not automatically released in some 
cases. For example, in the set overlay screen function, the destination screen contains a called screen in which the 
authorization control is enabled.)
When another equipment in the control group tries to obtain the authorization, even if the authorized equipment is 
displaying a screen in which the authorization control is enabled, the authorization is released from the authorized 
equipment.
However, if the authorization guarantee time is set, the authorization is not released until the set time elapses from the 
last operation.
To manually release the authorization, perform the operation on the popup display.

➟(3) Operation on the popup display
On the master GOT, you can also release the authorization from the authorized equipment by using the GOT internal 
devices.

➟5.6.2 ■4 (1) Authorization control with devices
For the authorized GOT, the authorization is not released even if the GOT transitions to screen saver mode.

Setting of the destination basic screen Automatic acquisition of the authorization

The authorization control is enabled.
The applicable equipment tries to obtain the authorization at screen switching.
The automatic acquisition of the authorization can be disabled.
➟5.6.2 ■4 (1) Authorization control with devices

The authorization control is disabled. The applicable equipment does not try to obtain the authorization at screen switching.
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(3) Operation on the popup display
On the target equipment for the authorization control, you can check the authorization status and manually grant or 
release the authorization on the popup display.
The conditions for the popup display to appear differ depending on the target equipment.

The authorization is not required to perform operations on the popup display.
Example) Popup display on the GOT

1) Display position switching button
Switches the position of the popup display. (Top, middle, bottom)

2) Message display area
Displays information including the authorization status.
On the VNC server or VNC client, touching the message display area obtains the authorization of the VNC server 
function.
If you do so on the screen in which the authorization control is enabled, the authorization of the GOT network 
interaction function is obtained together.
The format of the IP address displayed in the message differs according to the equipment type.

*1 The IP address of the VNC server is displayed.
3) Home screen button

Switches to the home screen.
The home screen differs depending on the target equipment.

• For equipment other than the GOT Mobile function client
Base screen specified in [Specify the home screen No.] in the [GOT Network Interaction] dialog

• For the GOT Mobile function client
Mobile screen specified in [Specify the home screen No.] of [Exclusive Control of Operational Authority] in the 
[GOT Mobile Setting] window

If no screen is set as the home screen, touching this button displays the lowest numbered screen.

Target equipment Display condition

GT27, GT25, GT23, GS25
(other than the VNC server)

When a screen is switched to another screen in which the authorization control is enabled, the popup 
display appears.GT SoftGOT2000

GOT Mobile function client

GOT (VNC server) • When the authorization control of the VNC server function is enabled
The popup display always appears on the screen.
For the VNC client started with the exclusive password for monitoring, the popup display appears when a 
screen is switched to another screen in which the authorization control is enabled.

• When the authorization control of the VNC server function is disabled
The popup display appears when a screen is switched to another screen in which the authorization control 
is enabled.

VNC client

Type Format Example

GT27, GT25, GT23, GS25 (IP address):g(GOT ID) 192.168.3.18:g1

GT SoftGOT2000 (IP address):s(Module No.) 192.168.3.19:s1

VNC client *1 (IP address):v1 192.168.3.20:v1

GOT Mobile function client (IP address):m(Client No.) 192.168.3.21:m1

Display position: Top

Display position: Middle

Display positon: Bottom

1) 2) 3) 4)
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4) Status icon
Indicates the status of the target equipment.
Touching a status icon obtains or releases the authorization.
(This action is not available if the GOT Mobile function client is authenticated by using a guest operator account.)
The type of the target equipment determines the icon to be displayed.

*1 For the VNC client started with the exclusive password for monitoring, the icon when the authorization control 
of the VNC server function is disabled appears.

■4 Authorization control and status notification with devices
In the GOT network interaction function, by using the devices for the authorization control and status notification, you can 
prohibit equipment from obtaining the authorization, check the authorization status, and perform other operations.
The type of the target equipment determines the devices to be used.

(1) Authorization control with devices
The following shows how to control the operation of the GOT network interaction function with devices.

To ignore the authorization guarantee time and forcibly release the authorization from the authorized equipment, perform 
the following operation on the master GOT: Turn on GS1796.b1 to disable the authorization guarantee time, and then 
turn on GS1796.b0 or GS1796.b2.

Equipment

When displaying a 
screen in which the 

authorization control is 
disabled

When displaying a screen in which the authorization control is enabled

Unauthorized Authorized In process of obtaining 
authorization

Equipment other than the VNC 
server and VNC client

-VNC server, VNC client
(The authorization control of the 
VNC server function is disabled.)*1

VNC server, VNC client
(The authorization control of the 
VNC server function is enabled and 
the VNC server has the 
authorization.)

VNC server, VNC client
(The authorization control of the 
VNC server function is enabled and 
the VNC client has the 
authorization.)

Target equipment Devices for authorization control and status notification

GOT
GOT internal devices
➟12.1.3 GOT special register (GS)

GOT Mobile function client
Devices that are set in [Operational Authority Status Control Device] and [Operational Authority Status 
Notification Device] of [Exclusive Control of Operational Authority] in the [GOT Mobile Setting] window
➟10.19.6 [GOT Mobile Setting] window

Target equipment Control details
Operation

Equipment other than the GOT Mobile 
function client GOT Mobile function client

All

Disabling the automatic acquisition of the 
authorization at the time to switch to a 
screen in which the authorization control 
is enabled

Turn on GS1795.b0. Turn on b0 of [Operational Authority 
Status Control Device].

Master GOT
Prohibiting equipment except the master 
GOT in the control group from obtaining 
the authorization

Turn on GS1796.b0. -

Master GOT Disabling the authorization guarantee 
time Turn on GS1796.b1. -

Master GOT
Prohibiting equipment including the 
master GOT in the control group from 
obtaining the authorization

Turn on GS1796.b2. -
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(2) Status notification with devices
The following shows how to check the authorization status of the GOT network interaction function with devices.

Target equipment Notification details
Operation

Equipment other than the GOT Mobile 
function client GOT Mobile function client

All Notifying that the equipment obtains the 
authorization GS1460.b0 turns on. The b0 of [Operational Authority Status 

Notification Device] turns on.

All Notifying that a screen requiring the 
authorization is being displayed GS1460.b1 turns on. The b1 of [Operational Authority Status 

Notification Device] turns on.

Equipment other 
than the GOT 
Mobile function 
client

Notifying the IP address of the master 
GOT when the equipment obtains the 
authorization

GS1461 and GS1462 store the data. -

Equipment other 
than the GOT 
Mobile function 
client

Notifying the time (second) elapsed since 
the equipment obtained the authorization GS1463 stores the data. -

Equipment other 
than the GOT 
Mobile function 
client

Notifying the remaining authorization 
guarantee time (second) GS1464 stores the data. -

Master GOT Notifying that any equipment in the control 
group obtains the authorization GS1465.b0 turns on. -

Master GOT

Notifying that equipment except the 
master GOT in the control group is 
prohibited from obtaining the 
authorization (GS1796.b0 is on.)

GS1465.b1 turns on. -

Master GOT

Notifying that equipment including the 
master GOT in the control group is 
prohibited from obtaining the 
authorization (GS1796.b2 is on.)

GS1465.b2 turns on. -

Master GOT Notifying the IP address of the authorized 
equipment GS1466 and GS1467 store the data. -

Master GOT Notifying the type of the authorized 
equipment

GS1468 stores the data.
• 0: GOT
• 1: GT SoftGOT2000
• 2: GOT Mobile function client

-

Master GOT Notifying the identification information on 
the authorized equipment

GS1469 stores the data.
• GOT: GOT ID number
• GT SoftGOT2000: Module No.
• GOT Mobile function client: Client 

number

-

Master GOT Notifying the time (second) elapsed since 
the equipment obtained the authorization GS1470 stores the data. -
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5.6.3 Precautions

■1 Precautions for drawing
(1) Specifying the master GOT

Set the same master GOT IP address in the projects of the GOTs that are in the same authorization control group.
If you set different IP addresses, the exclusive authorization control is not available.

(2) Setting the home screen
When setting a screen as the home screen, make sure that the authorization control is disabled in the screen.
Otherwise, you cannot switch a screen to the home screen on unauthorized equipment.

■2 Precautions for use
(1) Master GOT startup timing

Start the master GOT earlier than other pieces of equipment in an authorization control group.
No equipment can obtain the authorization before the master GOT is started.

(2) Restrictions on the alarm popup display
While the popup display of the GOT network interaction function is being displayed, the alarm popup display is disabled.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.6.4 [GOT Network Interaction] dialog

In the [GOT Network Interaction] dialog, configure the settings for the GOT network interaction function.
Select [Common] → [GOT Network Interaction] from the menu to display this dialog.

1) [Use GOT network interaction function]
Enables the GOT network interaction function.

2) [GOT type to control operational authority]
Set the type of the master GOT.
When selecting [GT SoftGOT2000], configure the settings for the GOT network interaction function in GT 
SoftGOT2000.
For details, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual
3) [IP address]

Set the IP address of the master GOT.
4) [Port No.]

When selecting [GT SoftGOT2000] for [GOT type to control operational authority], specify the port number of the 
master GOT.
The setting range is [1024] to [65534].
When selecting [GOT] for [GOT type to control operational authority], the setting is fixed to [49159].

5) [Guaranteed time of operational authority after the last operation]
Set a period of time to hold the authorization after the authorized equipment is operated.
The setting range is [0] (Invalid) seconds to [3600] seconds.
This setting is disabled when GS1796.b1 is turned on.

6) [Specify the home screen No.]
Set a base screen as the home screen. On the popup display of the GOT network interaction function, touching the 
home screen button displays the set base screen.
Make sure that the authorization control is disabled in the set base screen.

7) [Browse] button
Displays the [Screen Image List] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)
5)
6)

8)

7)
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You can check screen images and select a screen as the home screen.

8) [Setting of [Target for exclusive control of operational authority] of base/window screens]

• [Screen Type]
Displays the screen type.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

Item Description

[Enable All] button Selects [Target for exclusive control of operational authority] for all the base screens and window screens.

[Disable All] button Clears [Target for exclusive control of operational authority] for all the base screens and window screens.

Screen image list

Jump
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5.7 Checking the Interface Settings of the GOT ([I/F Communication 
Setting])

➟5.7.1 Specifications of the I/F communication setting
5.7.2 How to use the I/F communication setting
5.7.3 [I/F Communication Setting] dialog

In the [I/F Communication Setting] dialog, set the communication interface of the GOT.

5.7.1 Specifications of the I/F communication setting

■1 Communication interface configuration
The following shows the GOT communication interfaces that appear in the [I/F Communication Setting] dialog.
The usable interfaces vary by GOT model.
For the details of each communication interface, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
GOT2000 Series Connection Manual for a controller used

(1) Communication interfaces of GT27, GT25-S, and GT25-V

The wireless LAN interface setting does not appear in the [I/F Communication Setting] dialog.
For the wireless LAN interface setting, refer to the following.

➟5.4.1 Setting the GOT IP address

(2) Communication interfaces of GT25-W, GT2505-V, GT25HS-V, and GS25

For GT25HS-V, do not select any item other than the above.
Otherwise, the setting becomes invalid.
The wireless LAN interface setting does not appear in the [I/F Communication Setting] dialog.
For the wireless LAN interface setting, refer to the following.

➟5.4.1 Setting the GOT IP address

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Interface Settable channel number

Standard interface

[I/F-1: RS422/485] [0], [1] to [4], [5] to [8]

[I/F-2: RS232] [0], [1] to [4], [5] to [8], [A]

[I/F-3:USB] [9]

Ethernet interface [Ethernet] [0], [1] to [4], [9], [A], [Multi]

Extension interface

[1st] [0], [1] to [4], [5] to [8], [A], [-]

[2nd] [0], [1] to [4], [5] to [8], [A], [-]

[3rd] [0], [1] to [4], [5] to [8], [A], [-]

Interface Settable channel number

Standard interface

[I/F-1: RS422/485] [0], [1] to [4], [5] to [8]

[I/F-2: RS232] [0], [1] to [4], [5] to [8], [A]

[I/F-3:USB] [9]

Ethernet interface [Ethernet] [0], [1] to [4], [9], [A], [Multi]
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(3) Communication interfaces of GT23

(4) Communication interfaces of GT2107-W, GT2104-R, and GS21

(5) Communication interfaces of GT2105-Q

(6) Communication interfaces of GT21-P

5.7.2 How to use the I/F communication setting

■1 Setting with GT Designer3
Step 1 Select [Common] → [I/F Communication Setting] from the menu.
Step 2 The [I/F Communication Setting] dialog appears.

Check and set the interface connection setting.
➟5.7.3 [I/F Communication Setting] dialog

■2 Using the parameter reflection function of MELSOFT Navigator
When setting [Controller Setting] in GT Designer3 using the parameter function of MELSOFT Navigator, all of I/F 
Communication Setting are grayout and cannot be edited.Set these items at [Controller Setting] or [Peripheral Unit 
Setting].

Interface Settable channel number

Standard interface

[I/F-1: RS422/485] [0], [1] to [2], [5] to [8]

[I/F-2: RS232] [0], [1] to [2], [5] to [8], [A]

[I/F-3:USB] [9]

Ethernet interface [Ethernet] [0], [1] to [2], [9], [A], [Multi]

Interface Settable channel number

Standard interface

[I/F-1: RS422/485] [0], [1] to [2], [8], [9]

[I/F-2: RS232] [0], [1] to [2], [8], [9], [A]

[I/F-3:USB] [9]

Ethernet interface [Ethernet] [0], [1] to [2], [9], [A], [Multi]

Interface Settable channel number

Standard interface

[I/F-1: RS422/485] [0], [1] to [2], [8], [9]

[I/F-2: RS232] [0], [1] to [2], [8], [9], [A]

[I/F-3:USB] [9]

Interface Settable channel number

Standard interface

[I/F-1: RS422/485/232(Side)] [0], [1] to [2], [8], [9]

[I/F-2: RS232(Back)] [0], [1] to [2], [8], [9], [A]

[I/F-3:USB] [9]

Ethernet interface [Ethernet] [0], [1] to [2], [9], [A], [Multi]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.7.3 [I/F Communication Setting] dialog

1) [Standard I/F Setting]
Set the channel No. and communication driver for the communication interface that included as standard.

Item Description

[I/F-1] to [I/F-3]
Displays the communication type of standard interfaces 1 to 3.
For the details of each standard interface, refer to the following.

➟5.7.1 ■1 Communication interface configuration

[CH No.]

Set a channel number for each standard interface.
The number of settable channels varies by GOT model.
• 0: Does not use the standard interface.
• 1 to 4: Used for the controllers of channel numbers 1 to 4 set in [Controller Setting].
• 5 to 8: Used for the barcode function, the RFID function, the remote personal computer 

operation function (Serial), and the GOT (Extended Computer).
• 9: Used for the host station (personal computer).
• A: Used for the report function (with a serial printer) and the hard copy function (with a 

serial printer).

[Driver]

Set a communication driver for each standard interface.
The settable communication drivers vary by GOT model or connection type.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

[Detail Setting] button

Displays the [Detail Setting] dialog.
Set the connection details, such as the number of retries and the communication timeout 
period.

➟12.15.5 [Detail Setting] dialog

[Enable the 5V power supply]
[Enable the 5V power supply (for GT14-
RS2T4-9P only)] (GT2505-V only)

Enables the 5 V power supply feed function through the standard interface ([I/F-2:RS232]).
Not available to GT23, GT21, GT SoftGOT2000, and GS21.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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2) [Ethernet Connection Setting]
Set a channel number and a communication driver for each Ethernet interface.
Not available to GT2105-Q.

3) [Extend I/F Setting]
Not available to GT2505-V, GT25HS-V, GT23, GT21, and GS21.
Set a channel number and a communication driver for the 1st to 3rd stages of the extension interface.

Item Description

[CH No.]

Set a channel number for each Ethernet interface.
The number of settable channels varies by GOT model.
• 0: Does not use the Ethernet interface.
• 1 to 4: Used for the controllers of channel numbers 1 to 4 set in [Controller Setting].
• 9: Used for the Ethernet download.
• A: Used for the remote personal computer operation function (Ethernet), the VNC server 

function, the gateway function, and the MES interface function.
• Multi: Used for the multi-channel Ethernet connection.

[Driver]

Set a communication driver for each Ethernet interface.
The settable communication drivers vary by GOT model or connection type.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

[Detail Setting] button

Displays the [Detail Setting] dialog.
Set the connection details, such as the number of retries and the communication timeout 
period.

➟12.15.5 [Detail Setting] dialog

Item Description

[1st] to [3rd] Displays the communication type of the extension interface (1st to 3rd stages).

[CH No.]

Set a channel number for each stage of the extension interface.
The number of settable channels varies by GOT model.
• 0: Does not use the extension interface.
• 1 to 4: Used for the controllers of channel numbers 1 to 4 set in [Controller Setting].
• 5 to 8: Used for the barcode function, the RFID function, and the remote personal 

computer operation function (Serial).
• A: Used for the report function (with a serial printer), the hard copy function (with a serial 

printer), the remote personal computer operation function (Ethernet), the video output 
function, the VNC server function, the gateway function, and the MES interface function.

• -: Indicates an unused stage when [Enable Ethernet extended port] is selected in the 
[Extended Port] tab of the [GOT Ethernet Setting] window ([GOT IP Address Setting]).

➟5.4.1 ■3 (2) [Extended Port] tab, [Port 2] tab

[Driver]

Set a communication driver for each stage of the extension interface.
The settable communication drivers vary by GOT model or connection type.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

[Detail Setting] button

Displays the [Detail Setting] dialog.
Set the connection details, such as the number of retries and the communication timeout 
period.

➟12.15.5 [Detail Setting] dialog

When the first stage is used and the second and third stages are not used

For the second stage, [-] appears in [CH No.] 
and [Ethernet Extended Port] appears in [Driver].
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5.8 Comment Setting ([Comment])

➟5.8.1 Specifications of comments
5.8.2 How to use comment
5.8.3 Precautions
5.8.4 Setting comments

Comments are the character strings registered to the project by a user.
Comments can be used for displaying the character strings with each object.
Comments are used for displaying the same character string with multiple objects or for displaying messages which are 
changed by the device value.
Comments supporting multiple languages can be displayed with the language switching device.
Example) Changing a message to be displayed on the comment display according to the device value of D100

5.8.1 Specifications of comments

■1 Number of comments

■2 Number of characters

■3 Applicable functions
• Touch switch
• Lamp
• Comment display
• Historical data list display
• Alarm display (user)

• Simple alarm display *1

• Alarm popup display

• Recipe display (record list) *1

• Graphical meter
• Document display

• Comment print *1

• Hyperlink object
*1 Windows fonts are not usable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Column No.1Comment No.

1

3

2

Start

Running

Done

Comment group No. 1
   D100 = 1

Start

Comment No.1 is 
displayed.

D100 = 2

Running

Comment No.2 is 
displayed.

D100 = 3

Done

Comment No.3 is 
displayed.
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Item Description

Max. No. of comment groups for a project 500

Max. No. of comments for a comment group 32767

Max. No. of comment columns for a comment group 30

Item Description

Comment group title Up to 32 characters

Comment Up to 1024 characters
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■4 Applicable font
(1) Font

• 12 dots (Standard, HQ Mincho, HQ Gothic)
• 16 dots (Standard, HQ Mincho, HQ Gothic)
• Windows font

(2) KANJI region
• Japan
• China(GB)-Mincho
• China(Big5)-Gothic

■5 Display attributes
The display attributes are settable for each comment.
The display attributes valid for displaying a comment vary with the object.

The following explains the details of each display attribute shown in the above table.

(1) Selectable
You can select the display attribute in the object setting or the one in the comment group setting.
To use the display attribute in the object setting, select [Change Attribute of Comment Setting] in the object setting.
To use the display attribute in the comment group setting, deselect this item.

(2) Nonexistent
The relevant display attribute is nonexistent for the object.
Accordingly, the display attribute in the comment group setting is invalid.

(3) Comment group setting
The display attribute in the comment group setting is used.
Accordingly, the display attribute in the object setting is invalid.

(4) Object setting
The display attribute in the object setting is used.
Accordingly, the display attribute in the comment group setting is invalid.

(5) Varying with the condition
When [Comment Color (System Alarm: Fixed)] is selected for [Switching Type] in [Alarm Text Color Switching] in the 
object setting, the display attribute in the comment group setting is used.

➟9.1.4 ■4 [Alarm Popup Display] dialog
When any other item is selected for [Switching Type], the display attribute in the object setting is used.

■6 Available file format for importing, exporting
Unicode text files and CSV files can be used.

Object name Text color Invert Blink High quality font Text style Shade color

Touch switch Selectable Nonexistent Nonexistent Comment group 
setting Selectable Selectable

Lamp Selectable Nonexistent Nonexistent Selectable Selectable Selectable

Comment display Selectable Selectable Selectable Selectable Selectable Selectable

Historical data list 
display Object setting Nonexistent Nonexistent Object setting Object setting Object setting

Alarm display (user), 
simple alarm display Object setting Nonexistent Nonexistent Object setting Object setting Object setting

Alarm popup display Varying with the 
condition Nonexistent Nonexistent Object setting Object setting Object setting

Recipe display 
(record list) Object setting Nonexistent Nonexistent Object setting Object setting Object setting

Graphical meter Selectable Nonexistent Nonexistent Object setting Object setting Object setting

Document display Nonexistent Nonexistent Nonexistent Nonexistent Nonexistent Nonexistent

Comment print Nonexistent Nonexistent Nonexistent Nonexistent Nonexistent Nonexistent

Hyperlink object Selectable Nonexistent Nonexistent Nonexistent Selectable Selectable
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5.8.2 How to use comment

Register comments to a comment group.
Create comment groups according to the usage of the comments and register the comments.
If you set multiple comment columns in a comment group, the comments prepared in multiple languages can be switched 
with language switching devices.
The device comments, which are created by GX Works2 or GX Developer, can be read and registered as a comment 
group.
For information on how to register comments to a comment group, refer to the following.

➟6.1.6 ■4 [Device Comment / Device Definition List] dialog

■1 Using comments
The following shows how to use comments.

Step 1 Create a comment group according to the usage of the comments.

➟5.8.4 ■2 Creating a new comment group
Step 2 Open the comment group and register comments.

➟5.8.4 ■1 Opening comment group
5.8.4 ■3 Creating a new row
5.8.4 ■4 Inserting a row
5.8.4 ■5 Inserting a column

Step 3 Set the comments for each object.

➟8.2 Placing a Touch Switch
8.3 Placing a Lamp
8.7 Placing a Comment Display
8.10 Placing a Historical Data List Display
8.11 Placing an Alarm Display
8.12 Placing a Simple Alarm Display

■2 Comment group
A comment group is a group of comments.
To register the comments, create a comment group in a project.
Multiple comment groups can be created in a project.
If multiple comment groups are created, the comment groups can be used according to the purpose.
Example) Specifying a comment group No. with a device and changing the comment type to be displayed

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Column No.1Comment No.

1

3

2

開始

実行中

完了

Comment group No.1: Comment for normal message

Column No.2

Start

Running

Done

Column No.1Comment No.

1

3

2

緊急停止

通信エラー

異物混入

Comment group No.2: Comment for error message

Column No.2

Emergency stop

Communication error

Contamination

開始 緊急停止

Comment for normal message

(Comment group No.1) is 

displayed.

Comment for error message

(Comment group No.2) is 

displayed.

D300 = 1 D300 = 2

Comment group No.: Specified with D300
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■3 Displaying multi-language comments (Language switching device)
If you set multiple comment columns in a comment group, the comments can be registered in multiple languages for one 
comment No.
The comments registered in multiple languages can be switched by switching the comment column to be displayed with 
the language switching devices.
Example) Switching comments with the language switching device

(1) Comment group which does not operate with language switching devices
If a comment group which does not operate with a language switching device is required, configure the following settings 
in the language switching device settings.

• Select [Display] for [Alternative Display (when the language switching device value is out of the range (1-30) or 
comment column No. does not exist)].

• Set [1] for [Comment Column No.].
By the above settings, column No.1 is always displayed regardless of the value of the language switching device if the 
comment group has column No.1 only.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

Column No.1Comment No.

1

3

2

開始

実行中

完了

Comment group No. 1

D500 = 1

開始

D500 = 2

Start

Column No.2

Start

Running

Done

Language switching device: D500
Comment No. to be displayed: 1

Comment of the column 

No.1 is displayed.
Comment of the column

No.2 is displayed.
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■4 Displaying the comments of a text file
Not available to GT23, GT21, and GS21.
The GOT can display comments by reading a comment text file from the installed data storage.
After you change a comment, overwrite the comment text file in the data storage and restart the GOT to display the new 
comment.

To display the comments of a text file, configure the relevant settings in the project.
Configure the settings by comment group.

(1) Procedure for displaying the comments of a text file
Configure the following settings for a comment group from which comments are exported to a text file.

Step 1 In the [Comment Group Property] dialog, configure the settings as shown below.
• Select [Read comment data from the memory card].
• Click the [File Access] button to display the [File Access] dialog, and set the save destination and file 

name of a text file.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

Step 2 Export a target comment group to the text file.
In the [Save As] dialog, set [File name] and [Format] as shown below.

• [File name]: Set the file name specified in the [File Access] dialog.
• [Format]: Select [GT Designer3-GOT Common Format].

➟5.8.4 ■7 Exporting comments
Step 3 Save the text file to the folder specified in the [File Access] dialog.
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
If the text file is saved after package data has been written to the GOT, restart the GOT.

Run

Displaying comment No. 1

Writing package data 
and the comment text file

Changing comments

Stop

Displaying comment No. 1
Overwriting the comment text file 

in the GOT

Personal computer (text editor)
· Editing the comment text file

Restarting the GOT

Personal computer (GT Designer3)
· Creating a project
· Exporting comments to a text file

Comment1.csv

package1

Comment1.csv

Comment text file
Comment No.
1 Stop

Column No. 1

Comment1.csvpackage1
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(2) Procedure for reflecting comment changes
Step 1 Edit a comment text file with a text editor, and overwrite the text file in the data storage with the edited one.
Step 2 Restart the GOT.

(3) Font restrictions
Windows fonts and HQ fonts are not usable to display the comments of a text file.
Even if a Windows font or HQ font is specified in the object setting dialog, the GOT displays the comments in a standard 
font.

(4) Influence on the GOT startup time
When this function is used, the GOT reads a comment text file at startup, resulting in a longer startup time.
To minimize the increase of the startup time, enable this function only for the comment group in which comments may be 
changed.

■5 Importing or exporting comments
Comments can be imported or exported with a personal computer.
Available text files are Unicode text file and CSV file.
If you need to set a large amount of comments, working hours required to create the comments can be shortened by 
importing the text files for comments created by multiple persons.
To create a new text file for comments, using a text file exported from a comment group is recommended.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

The format of the text files for comments is common for both Unicode text files and CSV files.
However, use the following delimiters for each file.

• Unicode text files: Tab (\t)
• CSV file: Comma (,)

The following three formats are supported.
Select a format for a comment text file according to the version of GT Designer3 to which the text file is imported.

Font specified in a text file Font used on the GOT

12-dot HQ Gothic
12-dot HQ Mincho

12-dot Standard

16-dot HQ Gothic
Windows fonts

16-dot Standard (Gothic)

16-dot HQ Mincho 16-dot Standard (Mincho)

Format Description

[GT Designer3-GOT Common Format]
Compatible with GT Designer3 Version 1.195D or later.
To display the comments of a text file, use this format.

➟(1) Format of the text file for comments

[Ver.1.165X - 1.190Y Compatible]
Compatible with GT Designer3 Version 1.165X to 1.190Y.

➟(2) Ver. 1.165X to 1.190Y-compatible format or Ver. 1.100E to 1.163V-compatible format

[Ver.1.100E - 1.163V Compatible]
Compatible with GT Designer3 Version 1.100E to 1.163V.

➟(2) Ver. 1.165X to 1.190Y-compatible format or Ver. 1.100E to 1.163V-compatible format

Comment No.
1
2
3

開始
運転中
完了

Column No.1
Start
Running
Done

Column No.2

Worker A 

creates comments of No.1 to 500 

in the column No.1 (Japanese).

Worker B 

creates comments of No.501 to 999 

in the column No.1 (Japanese).

Worker C 

creates translated comments used 

for column No.2.

CSV file for comments
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(1) Format of the text file for comments

1) Format version
The format version is fixed at [1.195D].

2) Comment group No.
Set a comment group No.
The setting range is 1 to 500.

3) Column No., remarks
Set a column No. of a comment column and a remarks for the comment columns.
Separate the column No. and the remarks with a one-byte space.
The setting range of the column Nos. is 1 to 30.
Up to 32 characters can be set as remarks.

4) Windows font and character set
Displays the Windows fonts that are selected in the [Comment Group Property] dialog.
Displays the character sets that are specified for the selected Windows fonts.
For the setting details, refer to the following.

➟5.8.4 ■2 (1) [Comment Group Property] dialog
Even if Windows fonts are set for the comments of a text file, the GOT displays the comments in standard fonts.

5) KANJI region
Set a KANJI region for each comment column.
The target comment column of the KANJI region is the comment column specified under these items.
The following shows the setting range of KANJI regions.

• 1: Japan
• 2: China(GB)-Mincho
• 3: China(Big5)-Gothic

6) Character property
Set character properties for each comment.
Input a property name to the first row, then input each setting in the subsequent rows.

Item Description

Character color
Set the comment text color with a hexadecimal color code.
The setting range is #000000 to #FFFFFF.

Reverse

Set whether to reverse the characters or not.
The following shows the setting range.
• Yes: Reversed
• No: Not reversed

Blink

Set a blink style of characters.
The following shows the setting range.
• None: Not blinking
• Low: Blinking at a low speed
• Med: Blinking at a medium speed
• High: Blinking at a high speed

Character effect

Set the text style.
The following shows the setting range.
• Blank: Standard
• B: Bold
• S: Shadow
• R: Embossed

Shade Color
Set the color of the shade when the character effect is shadow or engrave.
The setting range is the same as the character colors.

1)
2)
3)
4)
5)

6) 7)

8)

9)
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7) HQ font
Set whether to use a HQ font.
Input a property name to the first row, then input each setting in the subsequent rows.
The following shows the usable HQ fonts.

• 12-dot HQ Gothic
• 12-dot HQ Mincho
• 16-dot HQ Gothic
• 16-dot HQ Mincho

The following shows the setting range of each setting item.
• 0: Not used
• 1: Used

Even if HQ fonts are set for the comments of a text file, the GOT displays the comments in standard fonts.
8) Comment number

Set a comment number for the comment.
The setting range is 1 to 32767 (decimal) or 0x0001 to 0x7FFF (hexadecimal).

9) Comment
Input text for the comment.
Up to 1024 characters can be set.

(2) Ver. 1.165X to 1.190Y-compatible format or Ver. 1.100E to 1.163V-compatible format

1) Comment group No.
Set a comment group No.
The setting range is 1 to 500.

2) KANJI region
Set a KANJI region for each comment column.
The target comment column of the KANJI region is the comment column specified under these items.
The following shows the setting range of KANJI regions.

• 1: Japan
• 2: China(GB)-Mincho
• 3: China(Big5)-Gothic

3) Character property
Set character properties for each comment.
Input a property name to the first row, then input each setting in the subsequent rows.

Item Description

Character color

Set the comment character color by either of the following methods.
• Set a color name.

The following shows the available color names.
Black, blue, green, aqua, red, purple, yellow, white, dark white, gray, dark blue, dark 
green, dark aqua, dark red, dark purple, dark yellow

• Set a hexadecimal color code.
The setting range is #000000 to #FFFFFF.

Ver. 1.100E to 1.163V-compatible format

Ver. 1.165X to 1.190Y-compatible format

1) 2) 3) 4) 5)

6)

8)

9) 10)

7)

1) 2) 3) 4) 5)

6)

9) 10)

7)
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4) HQ font
Set whether to use a HQ font.
Input a property name to the first row, then input each setting in the subsequent rows.
The following shows the available characters and fonts.

• 12-dot HQ Gothic
• 12-dot HQ Mincho
• 16-dot HQ Gothic
• 16-dot HQ Mincho

The following shows the setting range of each setting item.
• Yes
• No

5) Numbers of characters, digits, and rows
The numbers of characters, digits, and rows of the comments are displayed.
These items are outputted when the comments are exported. However, inputting these items is not necessary for 
importing the comments.
The following shows the contents to be outputted.

• Number of characters
The number of characters contained in the comment.
A character is counted as one character, and a line feed is counted as two characters.

• Number of digits
The number of digits is required to store comments.
A one-byte character is counted as one character, and a two-byte character is counted as two characters. The 
number of the longest digits in all rows is displayed.
Line feeds are not counted to the number of digits.

• Number of lines
The number of lines of the comment.

Reverse

Set whether to reverse the characters or not.
The following shows the setting range.
• Yes
• No

Blink

Set a blink style of characters.
The following shows the setting range.
• None
• Low
• Medium
• High

Character effect

Set the text style.
The following shows the setting range.
• Normal
• Bold
• Solid
• Raised

Shade Color
Set the color of the shade when the character effect is shadow or engrave.
The setting range is the same as the character colors.

Item Description

Column No.1 Column No.2

はい。 
実行しました。

Yes.
Executed the task.

Number of
characters

(1)

Numbers of characters,digits, 
and rows of thecolumn No.1

Example. Description of the numbers of characters, digits, and rows in a CSV file

Number of 
columns 

(1)

Number of 
digits 
(1) 

Number of 
characters 

(2)

Number of 
columns 

(2)

Number of 
digits 
(2) 

12 14 2 23 17 2

Numbers of characters, digits, 
and rows of the column No.2
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6) Comment No. notation
Set the comment No. notation.
The following shows the setting range.

• Blank: Decimal
• HEX: Hexadecimal

7) Column No., remarks
Set a column No. of a comment column and a remarks for the comment columns.
Separate the column No. and the remarks with a one-byte space.
The setting range of the column Nos. is 1 to 30.
Up to 32 characters can be set as remarks.

8) Windows font and character set
Displays the Windows fonts that are selected in the [Comment Group Property] dialog.
Displays the character sets that are specified for the selected Windows fonts.
For the setting details, refer to the following.

➟5.8.4 ■2 (1) [Comment Group Property] dialog
9) Comment number

Set a comment number for the comment.
The setting range is 1 to 32767 (decimal) or 0x0001 to 0x7FFF (hexadecimal).

10) Comment
Input text for the comment.
Up to 1024 characters can be set.

■6 Comment registration using the characters of the text figure
In the text figure setting, you can register the characters entered in the [Text] field to a comment group, and convert the 
text figure to a simple comment display object.

For the registration method, refer to the following.
➟5.8.4 ■12 (1) Registering the characters of a text figure to a comment group

DRIVE DRIVE

Object settings
  Text: DRIVE

Object settings
  Comment group No. 1
  Comment No. 1

Converting the text figure to a simple comment display object

Comment group No. 1

1 DRIVE
Comment No. Comment

Automatically registering the characters
to a comment group
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■7 Comment registration using the text type [Text]
In the object setting, you can register the characters entered in the [Text] field to a comment group by changing the text 
type from [Text] to [Comment].

For the registration method, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

STOP STOP

Object settings
  Text type: Text
  Text: STOP

Object settings
  Text type: Comment
  Comment group No. 1
  Comment No. 2 

Changing the text type

Comment group No. 1

1
2

DRIVE
STOP

Comment No. Comment

Automatically registering 
the characters entered in 
the [Text] field to a 
comment group
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5.8.3 Precautions

■1 HQ character of Chinese (Simplified, Traditional)
(1) Chinese (Simplified)

Characters in Chinese (Simplified) cannot be displayed in the 12-dot HQ Gothic or 16-dot HQ Gothic font.
If the 12-dot HQ Gothic or 16-dot HQ Gothic is selected at the comment registration, the characters are displayed in the 
12-dot HQ Mincho or 16-dot HQ Mincho.

(2) Chinese (Traditional)
Characters in Chinese (Traditional) cannot be displayed in the 12-dot HQ Mincho or 16-dot HQ Mincho font.
If the 12-dot HQ Mincho or 16-dot HQ Mincho is selected at the comment registration, the characters are displayed in the 
12-dot HQ Gothic or 16-dot HQ Gothic.

■2 Exporting multi-language comments
A comment group for which multiple languages including Chinese are used may not be saved in a CVS file properly.
Export a comment group including multiple languages in the Unicode text file format.

■3 Importing the exported comments to GT Designer3 whose display language is different
If you export comments to a file with a GT Designer3 module, the file cannot be imported to another GT Designer3 module 
that uses a different display language.

■4 Overwriting comments when importing a text file for comments
When a text file for comments is imported, comments in the file are used to overwrite the comment group in the import 
destination.
Before importing comments, check the comment group in the import destination and comments in the text file to be 
imported.
For details, refer to the following.

➟5.8.4 ■6 Importing comments

■5 Precautions for using Windows fonts
(1) Project data size

When comments in Windows fonts are registered to comment groups, the project data size becomes large.
To reduce the project data size, configure the following settings.

• Separate comment groups into two types: group with the Windows font setting and group without the Windows font 
setting.

• Set the same text size for the objects that display the same comment.
• Set the same text style for the objects that display the same comment.

(2) Comment exceeding the display range in length
A comment exceeding the display range in length may appear incorrectly.
Set the comment within the display range.

(3) Display for a comment group of more than 128 MB
If the data size of a comment group exceeds 128 MB, some comments in Windows fonts are not displayed properly.
Make sure that the data size of a comment group is 128 MB or less.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.8.4 Setting comments

➟■1 Opening comment group
■2 Creating a new comment group
■3 Creating a new row
■4 Inserting a row
■5 Inserting a column
■6 Importing comments
■7 Exporting comments
■8 Comment searching
■9 Jumping to the specified comment
■10 Changing property
■11 Switching display or non-display of the property
■12 Registering characters to a comment group (Text figure, touch switch, and others)

■1 Opening comment group

The following shows a procedure to open the existing comment groups in the [Open Comment Group] dialog.
Step 1 Select [Common] → [Comment] → [Open] from the menu to open the [Open Comment Group] dialog.

➟5.8.4 (1) [Open Comment Group] dialog

Step 2 Select the target comment group and click the [Open] button.

➟5.8.4 ■1 (2) [Comment List] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Operation from the project tree
The existing comment groups can be opened from the [Project] window.
Step 1. Open [Comment] in the project tree in the [Project] window.

Step 2. A comment group is opened by either of the following operations.
• Double-clicking a comment group
• Right-clicking a comment group to select [Open]

(1) [Open Comment Group] dialog

The [Open Comment Group] dialog lists all the comment groups registered in the project.
In this dialog, you can create new comment groups and edit the existing comment groups.
Select [Common] → [Comment] → [Open] from the menu to display the dialog.

1) Comment group list
The list of comment groups registered to the project.
Select a comment group and double-click or click the [Open] button to display the [Comment List] window.
To open the [Comment List] window of multiple comment groups with a single operation, click the [Open] button 
while selecting multiple comment groups (up to 10).

➟5.8.4 ■1 (2) [Comment List] window
2) [New]

Creates a new comment group.
After clicking the [New] button, create a new comment group in the displayed dialog.

➟5.8.4 ■2 (1) [Comment Group Property] dialog
Up to 10 [Comment List] window can be displayed simultaneously.
When the 11th window opens, the first-edited (oldest in the edit history) [Comment List] window closes automatically.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
5 - 342 5. COMMON SETTING
5.8 Comment Setting ([Comment])



5

C
O

M
M

O
N

 S
ET

TI
N

G

(2) [Comment List] window

The [Comment List] window displays the list of the comments registered to a comment group.
➟5.8.4 ■1 (3) Setting items in the [Comment List] window

5.8.4 ■1 (4) Items in the right-click menu
5.8.4 ■1 (5) Manipulations using a mouse and keyboard

(3) Setting items in the [Comment List] window

1) [New] button
Creates a new comment.
A new comment is added to below the bottom row of the comment list.

➟5.8.4 ■2 Creating a new comment group
2) [Insert Row] button

Inserts a row in the comment list.
If multiple rows are selected in the comment list, the same number of new rows are inserted above the selected 
ones.
When a row is inserted in the consecutive comment Nos., all rows after the inserted row are renumbered.

➟5.8.4 ■4 Inserting a row
3) [Insert Column] button

Inserts a column in the comment column.
If multiple columns are selected in the comment list, the same number of new columns are inserted to the left of the 
selected ones.
When a column is inserted to the consecutive column Nos., all columns on the right of the inserted column are 
renumbered.

➟5.8.4 ■5 Inserting a column
4) [Comment Group Property] button

Check or change the detail of the comment group including the comment name and KANJI region.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

5) [Attribute Setting] button
Set the character property of comments.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟5.8.4 ■10 Changing property

6) [Import] button
Imports comments from a Unicode text file or a CSV file.
After clicking the button, select a file to import in the displayed dialog.

➟5.8.4 ■6 Importing comments
7) [Export] button

Exports a comment group into a Unicode text file or a CSV file.
After clicking the button, select a file to export in the displayed dialog.

➟5.8.4 ■7 Exporting comments
8) [Search] button

Searches a comment.
➟5.8.4 ■8 Comment searching

9) [Jump] button
Jumps to the specified comment No.

➟5.8.4 ■9 Jumping to the specified comment

• [Text]
Set the character color.

• [Blink]
Set the blinking speed of characters.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

• [Style]
Select a character effect.
The following shows the items to be selected.
• [Standard]
• [Bold]
• [Solid]
• [Raised]

• [Solid]
Select the shade color of characters when [Solid] or [Raised] is 
selected for [Style].

• [Invert]
Highlights characters.
This item can be selected only when [Regular] is selected for [Style].

• [Font Setting]
This item is displayed when [Read comment data from the memory 
card] is deselected in the [Comment Group Property] dialog.
Select a font for comments.
The following shows the items to be selected.
• [12dot HQ Gothic]
• [12dot HQ Mincho]
• [16dot HQ Gothic]
• [16dot HQ Mincho]

• [Search String]
Input a character string to search information.

• [Direction]
Select the search direction.

• [Search Next] button
Searches the next option.

• [Close] button
Closes the [Search] dialog.

• [Jump]
Set a target comment No.

• [Jump] button
Displays the comment No. which is specified in [Jump].

• [Close] button
Closes the [Jump] dialog.
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10) [Display/Hide Attribute] button
Switches display or non-display of the character property setting field, HQ character setting field, and outline font 
setting field.

➟5.8.4 ■11 Switching display or non-display of the property
11) [New Group] button

Creates a new comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

12) [Language Switching] button
Configures the language switching settings.
After clicking the button, configure the language switching settings in the [Environmental Setting] window.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
13) [Comment No. Notation Switching] button

Switches the comment No. notation of the comment No. field between decimal and hexadecimal.
14) Comment No. field

The field to display and change the comment Nos.
Comment Nos. are always displayed in ascending order.
Comment Nos. are assigned automatically when a new comment is created.
The comment Nos. can be changed by double-clicking a comment No cell.
Clicking a cell left to a comment No. selects the row.
To select multiple rows, perform one of the following operations.

• Hold down the [Ctrl] key and click a target cell. To deselect a selected row, perform the same operation.
• Select the first row in the range, hold down the [Shift] key, and click a target cell to select the last row in the 

range.
• Click the first cell and drag to the last cell in the range.

15) Comment field
The field to display and edit text of comments.

Item Description

Column No. and remarks Column No. and remarks of a comment column
Click a target cell to edit its contents.

Windows Font

This item is displayed when [Read comment data from the memory card] is deselected in 
the [Comment Group Property] dialog.
Displays the Windows fonts that are selected in the [Comment Group Property] dialog.
Click a Windows font cell to select the column.
To select multiple columns, perform one of the following operations.
• Click a Windows font cell to select the first column in the range, hold down the [Shift] key, 

and click another Windows font cell to select the last column in the range.
• Click a Windows font cell and drag to the last cell in the range.
To change the set Windows fonts, double-click a Windows font cell to display the 
[Comment Group Property] dialog.

➟5.8.4 ■2 (1) [Comment Group Property] dialog

KANJI region

KANJI region of a comment column
The KANJI region is changeable in the [Comment Group Property] dialog.
➟5.8.4 ■2 (1) [Comment Group Property] dialog
Click a KANJI region cell to select the column.
To select multiple columns, perform one of the following operations.
• Click a KANJI region cell to select the first column in the range, hold down the [Shift] key, 

and click another KANJI region cell to select the last column in the range.
• Click a KANJI region cell and drag to the last cell in the range.

Comment Set the comment corresponding to a comment No.
Double-click a target cell to edit its comment.

KANJI region
Windows Font

Column No. 
and remarks

Comment
5. COMMON SETTING
5.8 Comment Setting ([Comment])

5 - 345



16) Character property setting field
The field to display and set the character property of comments.
Available character properties differ depending on the object types.
For the difference among the object types, refer to the following.

➟5.8.1 ■5 Display attributes

17) HQ character setting
This item is displayed when [Read comment data from the memory card] is deselected in the [Comment Group 
Property] dialog.
Set whether to use HQ characters.
The fonts selected in this setting can be used for objects.
However, some objects cannot use some fonts even if the fonts are selected in this setting.
For the difference among the object types, refer to the following.

➟5.8.1 ■5 Display attributes

(4) Items in the right-click menu
The [Comment List] window can be edited with the right-click menu.

1) [New Row]
Creates a new comment.
A new comment is added to below the bottom row of the comment list.

2) [Cut]
Cuts a selected row, column, or cell.

3) [Copy]
Copies a selected row, column, or cell.

4) [Paste]
Paste the cut or copied row, column, or cell.

5) [Insert Row]

Item Description

Character color Set the character color.
Select a color from the color palette.

Reverse Select this item to highlight the characters.
This item can be selected only when [Regular] is selected for [Style].

Blink

Set the blinking speed of characters.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

Character effect

Select a character effect.
The following shows the items to be selected.
• [Standard]
• [Bold]
• [Solid]
• [Raised]

Shade Color Select the shade color of characters when [Solid] or [Raised] is selected for [Style].
Select a color from the color palette.
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Inserts a row in the comment list.
If multiple rows are selected in the comment list, the same number of new rows are inserted above the selected 
ones.
When a row is inserted in the consecutive comment Nos., all rows after the inserted row are renumbered.

6) [Insert Column]
Inserts a column in the comment list.
If multiple columns are selected in the comment list, the same number of new columns are inserted to the left of the 
selected ones.
When a column is inserted to the consecutive column Nos., all columns on the right of the inserted column are 
renumbered.

7) [Delete]
Deletes a selected row, column, or cell.

8) [Clear Text]
Deletes the character strings set in a selected row or column.

9) [Copy to Excel]
Copies a selected row or column to an Excel sheet.
Paste the selected row or column to an Excel sheet.

10) [Paste from Excel]
Pastes a column or cell to the comment list.
Cut or copy the column or cell in the source Excel worksheet in advance.
If the number of columns to be pasted exceeds the number of columns in the comment list, new columns are added 
to the comment list.

11) [Select All]
Selects all the comments in the comment list.

12) [Property]
Set the character property of comments.

(5) Manipulations using a mouse and keyboard
The following shows how to manipulate the cells in the [Comment List] window with a mouse and keyboard.
You can select, copy, cut, or paste the cells in the comment No. field and the comment field.

• [Text]
Set the character color.

• [Blink]
Set the blinking speed of characters.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

• [Style]
Select a character effect.
The following shows the items to be selected.
• [Standard]
• [Bold]
• [Solid]
• [Raised]

• [Solid]
Select the shade color of characters when [Solid] or [Raised] is 
selected for [Style].

• [Invert]
Highlights characters.
This item can be set only when [Regular] is selected for [Style].

• [Font Setting]
This item is displayed when [Read comment data from the memory 
card] is deselected in the [Comment Group Property] dialog.
Select a font for comments.
The following shows the items to be selected.
• [12dot HQ Gothic]
• [12dot HQ Mincho]
• [16dot HQ Gothic]
• [16dot HQ Mincho]

Operation Action

Arrow (Up/Down/Left/Right) Move the cell pointer.

[Shift] + Arrow (Up/Down/Left/Right)
Extend the selection of cells.
Select the first cell, hold down the [Shift] key and press an arrow key to extend the 
selection.
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■2 Creating a new comment group

The following shows how to create a comment group.
Step 1 Open the [Comment Group Property] dialog by either of the following operations.

• Selecting [Common] → [Comment] →[Open] from the menu to open the [Open Comment Group] dialog 
and double-clicking the [New] button

➟5.8.4 ■1 (1) [Open Comment Group] dialog
• Double-clicking the [New] button under [Comment] in the project tree in the [Project] window

➟2.2.4 ■1 [Project] window
• Right-clicking [Comment] of the project tree and selecting [New Comment Group] from the menu

➟2.2.4 ■1 [Project] window
Step 2 Set the created comment group in the [Comment Group Property] dialog.

➟5.8.4 ■2 (1) [Comment Group Property] dialog

(1) [Comment Group Property] dialog

Create a new comment group in the [Comment Group Property] dialog.
Select [Common] → [Comment] → [New Comment Group] from the menu to display the dialog.

1) [Group No.]
Set a comment group No.

2) Title
Set a title of the comment group.
Up to 32 characters can be set.

3) [Column No.]
Set column Nos. to be used in the comment group.
Select column Nos. to be used.

[Shift] + Click Select a range of cells. 
Select the first cell in the range, hold down the [Shift] key and click the last cell in the range.

[Ctrl] + [C] Copy the contents of a selected cell.
When multiple cells are selected, the contents of all the selected cells are copied.

[Ctrl] + [X] Cut the contents of a selected cell.

[Ctrl] + [V] Paste the contents of the clipboard to a selected cell.

Operation Action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4) [KANJI Region]
Set a KANJI region for each comment column.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

5) [Remark]
Set remarks for each comment column.
Up to 32 characters can be set.

6) [Windows Font]
This item is displayed when [Read comment data from the memory card] is deselected.
Select a Windows font for each comment column.

7) [Character Set]
This item is displayed when [Read comment data from the memory card] is deselected.
Select a character set for each selected Windows font.
The selectable character sets vary with the selected Windows font.

8) [Prioritize language switching of GOT environmental setting]
Set whether to prioritize the setting in this dialog over the settings of the language switching of the GOT 
environmental settings.
This item can be set only when the language switching device is set in the GOT environmental settings.

9) [Read comment data from the memory card]
Not available to GT23, GT21, and GS21.
Displays comments by reading a comment text file from the data storage installed on the GOT.
Click the [File Access] button to display the [File Access] dialog.

Item Description

[Alternative Display (when the language 
switching device value is out of the range (1-
30) or comment column No. does not exist)]

Set the display method of the comment columns for when the column No. of the comment 
column specified by the language switching device does not exist.
The following shows the items to be selected.
• [Not display]

Comments are not displayed.
• [Display]

The comment of the specified column No. is displayed.
After selecting this item, set a column No. of the column to be displayed.
When [Read comment data from the memory card] is selected, the comment column 
number specified in [Language Switching] in the GOT environmental settings is applied.

Set the save destination and file name of a text file.
• [Drive Name]

Select a drive to which the text file is saved.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

• [Folder Name]
Specify the name of the folder to which the text file is saved.
For the restrictions on the folder name used in the GOT, refer to the 
following.
➟12.7 Restrictions for Folder Names and File Names used in GOT

• [File Name]
Specify the name of the text file to be saved.
The text file can be saved as a Unicode text (*.TXT) or CSV (*.CSV) 
file.
For the restrictions of the file name used in the GOT, refer to the 
following.
➟12.7 Restrictions for Folder Names and File Names used in GOT
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■3 Creating a new row

Create a new comment row in the [Comment List] window or the project tree.
The number which is one plus the largest comment No. in the comment groups is assigned to the comment No. of a new 
comment.
The largest settable comment No. is 32767 (or 7FFF in hexadecimal).
If 32767 (or 7FFF in hexadecimal) is already used, the smallest unused number in the comment group is assigned to the 
new comment.

Step 1 Perform either of the following operations.
• In the [Comment List] window, click the [New Row] button or select [New] from the right-click menu.

• In the project tree, select a comment group and select [Add Comment Row] in the right-click menu.
A new row is created in the comment list.

■4 Inserting a row

Insert a row in the [Comment List] window.
If multiple rows are selected in the comment list, the same number of new rows are inserted above the selected ones.
When a row is inserted in the consecutive comment Nos., all rows after the inserted row are renumbered.

Step 1 Select a place to insert a row in the [Comment List] window.

Step 2 Click the [Insert Row] button, or select [Insert Row] from the right-click menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[New] in the 
right-click menu

[New Row] 
button
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Step 3 A row is inserted above the selected row.

■5 Inserting a column

Insert a column in the [Comment List] window.
If multiple columns are selected in the comment list, the same number of new columns are inserted to the left of the 
selected ones.
When a column is inserted to the consecutive column Nos., all columns on the right of the inserted column are 
renumbered.

Step 1 Select a place to insert a column in the [Comment List] window.

Step 2 Click the [Insert Column] button, or select [Insert Column] from the right-click menu.

Step 3 A column is inserted to the left side of the selected column.

[Insert Row] 
button

[Insert Row] 
in the right-click 
menu
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button
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■6 Importing comments

Comments in a comment group can be set in the dialog. 
Also, comments can be registered or changed by importing a user-created comment text file.
For how to create a comment text file and its format, refer to the following.

➟5.8.2 ■5 Importing or exporting comments

(1) Adding or overwriting comments when importing comments from a file
The comment Nos. of the comments in the file to be imported and the comment Nos. of the registered comments are 
compared.

• If the comment Nos. are different each other, the comments in the file are added to the registered comments.
• If the comment Nos. are the same, the registered comments are overwritten with the comments in the file.

(2) Setting procedure
Import comments in the [Comment List] window.

Step 1 Click the [Import] button, or select [Common] → [Comment] → [Import] from the menu.

Step 2 Select a file to be imported.

Step 3 The following dialog appears.
Click the [Yes] button to import the comments in a text file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Importing

CSV file GT Designer3 GT Designer3

Overwritten
Added

[Import] 
button
5 - 352 5. COMMON SETTING
5.8 Comment Setting ([Comment])



5

C
O

M
M

O
N

 S
ET

TI
N

G

■7 Exporting comments

The registered comments in a comment group can be exported as a Unicode text file (*.TXT) or a CSV file (*.CSV).
You can view or edit the exported file with the text editor, spreadsheet software, or other tools.
To export comments, open the [Comment List] window and export comments, or export comments in the project tree.
For the format of text files for comments, refer to the following.

➟5.8.2 ■5 Importing or exporting comments

(1) Exporting comments from the [Comment List] window
Step 1 Click the [Export] button, or select [Common] → [Comment] → [Export] from the menu.

Step 2 Set [File name], [Save as type], and [Format] to save the file.

Step 3 The comment group is exported.

(2) Exporting from the project tree
Step 1 Select a comment group in the project tree and select [Export] in the right-click menu.

➟2.2.4 ■1 [Project] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 2 Set [File name], [Save as type], and [Format] to save the file.

Step 3 The comment group is exported.

■8 Comment searching

Search a comment in the [Comment List] window.
Step 1 Click the [Search] button.

Step 2 Search a comment in the [Search] dialog.

[Export] in the 
right-click menu

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Search] 
button
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■9 Jumping to the specified comment

Jump to the specified comment from the [Comment List] window.
Step 1 Click the [Jump] button.

Step 2 Set a target to jump in the [Jump] dialog and click the [Jump] button.

■10 Changing property

Change the character property of a comment in the [Comment List] window.
Edit the character property in the [Attributes] or [High Quality Font] field.

The following shows the methods of the batch editing for the character property of multiple comments.
• Changing the character property of an entire column in the [Comment List] window

➟5.8.4 ■10 (1) Changing the character property of an entire column in the [Comment List] window
• Using the [Attribute Setting] dialog

➟5.8.4 ■10 (2) Using the [Attribute Setting] dialog

(1) Changing the character property of an entire column in the [Comment List] window

Step 1 Click an entire column of the character property to be changed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Jump] 
button
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Step 2 Click an option of the property to edit the character property in batch.

(2) Using the [Attribute Setting] dialog

Step 1 Select a comment to change the character property in the [Comment List] window and click the [Attribute 
Setting] button.

Step 2 Change the character property of the comment in the [Attribute Setting] dialog.

➟5.8.4 ■10 (3) [Attribute Setting] dialog

(3) [Attribute Setting] dialog

Change the character property and font of the comment in the [Attribute Setting] dialog.

1) [Text]
Set the character color.

2) [Blink]
Set the blinking speed of characters.
The following shows the items to be selected.

• [None]
• [Low]
• [Medium]
• [High]

3) [Style]
Select a character effect.
The following shows the items to be selected.

• [Standard]
• [Bold]
• [Solid]
• [Raised]

4) [Solid]
Select the shade color of characters when [Solid] or [Raised] is selected for [Style].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Attribute Setting] 
button
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5) [Invert]
Highlights characters.
This item can be selected only when [Regular] is selected for [Style].

6) [Font Setting]
This item is displayed when [Read comment data from the memory card] is deselected in the [Comment Group 
Property] dialog.
Select a font for the comment.
The following shows the items to be selected.

• [12dot HQ Gothic]
• [12dot HQ Mincho]
• [16dot HQ Gothic]
• [16dot HQ Mincho]

7) [Set as Default] button
Sets the input setting in this dialog as the default value.

➟11.10.6 Customizing the default value
8) [Reset] button

Resets the input setting in this dialog to the initial value.

■11 Switching display or non-display of the property

In the [Comment List] window, displaying or hiding the character property can be switched.
Switch display or non-display of the character property using the [Display/Hide Attribute] button.

■12 Registering characters to a comment group (Text figure, touch switch, and others)

➟(1) Registering the characters of a text figure to a comment group
(2) Registering the characters in the [Text] field to a comment group

(1) Registering the characters of a text figure to a comment group
In the text figure setting, you can register the characters entered in the [Text] field to a comment group, and convert the 
text figure to a simple comment display object.

Step 1 Open the text figure setting dialog, and click the [Convert to Comment Display] button.

Step 2 In the [Comment Auto-Allocation] dialog, set [Group No.] and [Column No.] of the comment group.
You cannot register the characters to a comment group where identical characters already exit.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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button
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1) [Group No.]
Set the number of the comment group where the characters are to be registered.

2) [Column No.]
Set the column number of the comment group where the characters are to be registered.

Step 3 Click the [OK] button to register the characters to the comment group and covert the text figure to a simple 
comment display object.
In the [Simple Comment Display] dialog, click the [OK] button to execute the conversion, or the [Cancel] 
button to cancel the conversion. However, registering the characters to the comment group is not canceled.

(2) Registering the characters in the [Text] field to a comment group
For the following objects, when entering characters in the [Text] field, you can register the characters to a comment group 
by changing the text type from [Text] to [Comment], and enable the registered comment to be referred.

• Touch switch
• Lamp

The following shows the registration procedure for a bit switch as an example.
Step 1 Open the object setting dialog, and select the [Text] tab.
Step 2 Select [Text] in [Text Type].

Step 3 In the [Comment Auto-Allocation] dialog, set [Group No.] and [Column No.] of the comment group.
You cannot register the characters to a comment group where identical characters already exit.

1) [Group No.]
Set the number of the comment group where the characters are to be registered.

2) [Column No.]
Set the column number of the comment group where the characters are to be registered.

Step 4 To register the characters to the comment group, click [Yes] button.
To not to register the characters to the comment group, click [No] button.
To cancel converting the text type to [Comment], click [Cancel] button.

Selecting 
[Comment]

1)
2)
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5.9 Registering Parts ([Parts])

➟5.9.1 Outline of parts
5.9.2 Specifications of parts
5.9.3 How to use parts ([Parts])
5.9.4 Precautions
5.9.5 [Parts Image List] window
5.9.6 [Parts Setting] dialog

5.9.1 Outline of parts

Groups of figures can be registered as parts.
Each of the registered parts can be set as a shape to each object.
The parts can also be placed directly on the screen as a figure.
Objects for which parts can be used depends on the figures registered as parts.

■1 Using parts for parts display and parts movement objects
If the parts are set to a parts display or parts movement object, the GOT can display multiple parts by switching the display 
or display movements of the parts.

If displaying a part as a mark, you can change the white-colored area of the part to other colors.

Register a part to be displayed as a mark as follows.
• Do not use a BMP, JPEG, or PNG file as a part to be displayed as a mark.

(The color of the figure cannot be switched.)
• Draw the area of the figure, whose color is to be changed, in white.

■2 Using a part as a figure
Parts can be placed on the screen as they are.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Registered parts

Part No.1 Part No.2 Part No.3

D10 D101

Part No.1 is displayed. Part No.3 is displayed.

3

White Blue Red

The display color of the white space can be changed.

Registered parts

Part No.1 Part No.2 Part No.3

The parts can be placed 
on the base screen as shapes.
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■3 Using a part as the shapes for objects
Parts can be set as the shapes for objects including switches or lamps.

5.9.2 Specifications of parts

■1 Number of registerable parts per project
Up to 32767 parts can be registered per project.

■2 Figures placeable per part
Up to 10000 figures can be placed per part.
The volume of the data used for the part is the total volume of the data of the figures placed to the part.
The following figures can be placed to a part.

• Basic figure:
Line, freeform line, rectangle, polygon, circle, arc, sector, scale, piping, and paint

➟7.3 Drawing a Line
7.4 Drawing a Line Freeform
7.5 Drawing a Rectangle
7.6 Drawing a Polygon
7.7 Drawing a Circle
7.8 Drawing an Arc or a Sector
7.10 Drawing a Scale
7.11 Drawing a Piping
7.12 Painting Figures

• Character string: Text and logo text
➟7.1 Drawing a Text

7.2 Drawing a Logo Text
• Image: BMP file, JPEG file, and PNG file

➟7.13 Pasting an Image File

Registered parts

Part No.1 Part No.2

X10 OFF

The part can be set 
as the shape for a lamp.

X10 ON

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5.9.3 How to use parts ([Parts])

➟■1 Registering parts
■2 Copying parts
■3 Deleting parts
■4 Editing parts
■5 Changing part numbers and names
■6 Using the image file stored in the data storage as a part

Select a part in the [Parts Image List] window or in the project tree to create, edit, or delete a part or change the property 
of a part.
For how to and display the [Parts Image List] window, refer to the following.

➟5.9.5 [Parts Image List] window
For how to display the project tree, refer to the following.

➟2.2.4 ■1 [Project] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Project tree
· A shape can be registered as a part by dragging it   from the screen editor and releasing it in the project tree. 
· The parts image list window and the parts editor can be displayed.

Parts editor
· This editor is for the editing of parts. 
  You can edit the registered parts.

Double-click and 
edit the part.

[Parts Image List] window
· A shape can be registered as a part by clicking the [Register] icon. 
· You can check the image of the registered shape.

Drag and 
register the part.

Click and edit 
the part.
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■1 Registering parts

Parts can be registered in either of the following two methods: You can register a figure on the screen editor or you can 
newly create a part to register it.

➟5.9.3 ■1 (1) Registering a figure on the screen editor
　 5.9.3 ■1 (2) Creating a new part

(1) Registering a figure on the screen editor

(a) Registering a figure as a part in the [Screen Image List] window
Step 1 To register a figure on the screen editor as a part, select the figure and perform either of the following 

operations.
• Clicking the [Register] button in the [Parts Image List] window
• Selecting [Register to Parts] in the right-click menu.

Step 2 The [Parts Property] dialog appears.
Set [Number] and [Name] then click the [OK] button.
The part is registered in the project data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Select a figure in the screen editor.

Clicking the [Register] button in the [Parts Image List] window

Selecting [Register to Parts] in the right-click menu.
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(b) Registering a figure as a part from the project tree
Step 1 Drag the figure to be registered as a part onto the project tree.

Step 2 The [Parts Property] dialog appears.
Set [Number] and [Name] then click the [OK] button.
The part is registered in the project data.

(2) Creating a new part

Step 1 Select [Common] → [Parts] →[New] from the menu or perform either of the following operations in the [Parts 
Image List] window.

• Clicking the [New] button
• Selecting [New] in the right-click menu

Step 2 The [Parts Property] dialog appears.
Set [Number] and [Name] then click the [OK] button.
The part is registered in the project data.

Step 3 Draw a figure to be registered as a part on the parts editor.
After drawing the figure, close the parts editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Click the 

[New] 

button.

Select [New] 

in the right-click menu.
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■2 Copying parts

(1) Copying a part in the part image list
Step 1 Select a part to be copied in the [Parts Image List] window.

After selecting the part, perform either of the following operations.
• Clicking the [Copy] button
• Selecting [Copy] in the right-click menu

Step 2 Click the [Paste] button or right-click a part to select [Paste] from the menu.

Step 3 The [Parts Property] dialog appears.
Set [Number] and [Name] then click the [OK] button.
The part is registered in the project data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Click the 

[Copy] 

button. Select [Copy] 

in the right-click 

menu.

Click the 

[Paste] 

button.

Select [Paste] 

in the right-click 

menu.
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(2) Copying a part in the project tree
Step 1 Select a part to be copied in the project tree.

Right-click the selected part to select [Copy] from the menu.

Step 2 Right-click [Parts] to select [Paste].

Step 3 The [Parts Property] dialog appears.
Set [Number] and [Name] then click the [OK] button.
The part is registered in the project data.

Select [Copy] 

in the right-click menu.

Select [Paste]

 in the right-click menu.
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■3 Deleting parts

(1) Deleting a part in the part image list
Step 1 Select a part to be deleted in the [Parts Image List] window.

After selecting the part, perform either of the following operations.
• Clicking the [Delete] button
• Selecting [Delete] in the right-click menu

Step 2 The confirmation dialog is displayed.
Click the [Yes] button to delete the part displayed on the confirmation dialog.
Click the [Delete All] button to delete all the selected parts.
Click the [No] button to cancel the deletion of the part displayed on the confirmation dialog.
Click the [Cancel] button to cancel the deletion of all the selected parts.

(2) Deleting a part in the project tree
Step 1 Select a part to be deleted in the project tree.

Right-click the selected part to select [Delete] from the menu.

Step 2 The confirmation dialog is displayed.
Click the [Yes] button to delete the part displayed on the confirmation dialog.
Click the [Delete All] button to delete all the selected parts.
Click the [No] button to cancel the deletion of the part displayed on the confirmation dialog.
Click the [Cancel] button to cancel the deletion of all the selected parts.
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Click the 

[Delete] 

button.

Select [Delete] 

in the right-click 

menu.

Select [Delete] 

in the right-click menu.
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■4 Editing parts

(1) Editing a part from the part-image list
Step 1 Select a part to be edited in the [Parts Image List] window.

After selecting the part, perform either of the following operations.
• Clicking the [Edit] button
• Selecting [Edit] in the right-click menu

Step 2 The parts editor appears.
Edit the selected part.
After editing the part, close the parts editor.

(2) Editing a part from the project tree
Step 1 Select a part to be edited in the project tree.

Right-click the selected part to select [Edit] from the menu.

Step 2 The parts editor appears.
Edit the selected part.
After editing the part, close the parts editor.
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Click the 

[Edit] button.
Select [Edit] 

in the right-click menu.

Click [Edit] 

in the right-click menu.
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■5 Changing part numbers and names

(1) Changing the number or name of a part in the part image list
Step 1 Select a part whose number or name is to be changed in the [Parts Image List] window.

After selecting the part, perform either of the following operations.
• Clicking the [Property] button
• Selecting [Property] in the right-click menu

Step 2 The [Parts Property] dialog appears.
After changing [Number] or [Name], click the [OK] button to apply the change.

(2) Changing the number or name of a part in the project tree
Step 1 Select a part whose number or name is to be changed in the project tree.

Right-click the selected part to select [Property] from the menu.

Step 2 The [Parts Property] dialog appears.
After changing [Number] or [Name], click the [OK] button to apply the change.
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Click the 

[Property] 

button.

Select [Property] 

in the right-click menu.

Select [Property] 

in the right-click menu.
5 - 368 5. COMMON SETTING
5.9 Registering Parts ([Parts])



5

C
O

M
M

O
N

 S
ET

TI
N

G

■6 Using the image file stored in the data storage as a part

The image file stored in the data storage can be used for the parts display or parts movement.
Storing parts in the data storage reduces the size of the project data.

The following two methods are provided to use an image file in the data storage as a part.
➟5.9.3 ■6 (1) Specifying an image file from an object

　 5.9.3 ■6 (2) Specifying an image file in the project

(1) Specifying an image file from an object
Specify an image-file part stored in the data storage in the object setting of the parts display or parts movement.
Prepare one folder for each object to save image files separately per object.

The following shows the procedure to register image files.
Step 1 Create a folder in the data storage to store image files.

Create a folder per object (parts display or parts movement).
The folder name must be the same as the name set for the parts display or parts movement.

Step 2 Store an image file to be used as a part to the created folder.
The file name must be the same as the name set for the parts display or parts movement.
Exsample) File name: IMG, parts No.: 0123, number of digits: 4

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Store image files 

to the data storage.Image files 

(BMP, JPEG, PNG)

Install the data storage

to the GOT.

Display the image files in

the data storage as parts.

Item Description

Folder name Specified with the setting of the parts display or parts movement.

File name Specified with the setting of the parts display or parts movement.

Available drive Drive A, drive B, drive E, drive F, drive G, and drive X (current drive)

Setting range Object units

Maximum number of parts Max. 65536 parts

For Parts display No1
For Parts display No.2
For Parts display No.3

Parts display 
No.1

Parts display 
No.3

Parts display 
No.2

Create a folder for image files 

for the parts display and parts 

movement in the data storage.

Image folder

IMG01

IMG02

IMG03

Used for the parts 
display No.1

Used for the parts 
display No.2

Used for the parts 
display No.3
5. COMMON SETTING
5.9 Registering Parts ([Parts])

5 - 369



Parts No. is assigned according to [Digits] set for the parts display or parts movement.
• Five digits: 00001 to 65535
• Four digits: 0001 to 9999
• Three digits: 001 to 999
• Two digits: 01 to 99
• One digit: 1 to 9

(2) Specifying an image file in the project
Not available to GT21 and GS21.
Use parts No. 9001 or later number as the numbers dedicated for image-file parts.
In this case, store image files in one folder.
The file name and the folder name are fixed.

The following shows the procedure to register image files.
Step 1 Create a folder name it as IMAGE in the SD-card.

If any name other than IMAGE is used for the folder, the image file cannot be displayed with the parts display 
or parts movement.

Step 2 Store image files to be used as parts in the IMAGE folder in the SD-card.
Set each file name as follows.
Example) Parts No.: 9123

I M G 0 1 2 3 . B M P

Parts No.

The file name set in the parts

 display and parts movement

Item Description

Folder name IMAGE (fixed)

File name IMG + 0 + rightmost three digits of the parts No,

Available drive Drive A

Setting range Project units

Maximum number of parts Max. 999 parts

IMAGE
IMG0001.bmp
IMG0002.bmp

IMG0003.bmp

Parts No.9001

Parts No.9003

Parts No.9002

Create a folder for image files

 for the parts display and parts

 movement in the SD card. 

(Folder name: IMAGE)

Image folder

IMAGE
Used for the 

whole project

I M G 0 1 2 3 . B M P

Rightmost three digits of the parts No.

0 (fixed)

IMG (fixed)
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5.9.4 Precautions

■1 Restriction for displaying figures
(1) Line width of outer frame

Draw the external frame of the figure with one dot of the line width to register as a part.
The outer frame line with the width of two or more dots may not be displayed correctly.
To display the outer frame line with the width of two or more dots, perform either of the following operations.

• Drawing the outer frame line in combination with figures that have one-dot line width

• Setting a figure with an outer frame of two or more dots on the unused base screen and displaying the base screen 
as a part in the parts display

(2) Line width of line (excluding slant lines)
A line (excluding slant lines) that has the width of two to seven dots and has been registered as a part may not be 
displayed correctly.
To display the line with the width of two or more dots, perform either of the following operations.

• Drawing a line by deforming a rectangle (color fill)
• Drawing a line in combination with lines that have one-dot line width

■2 Size of the image-file parts stored in the data storage
BMP JPEG, or PNG parts are displayed on the GOT in the same size as the ones of the image-file parts stored in the 
data storage.
The image file bigger than the display size of the GOT cannot be displayed.
Store image-file parts whose sizes are the same as or smaller than the display size of GOT in the data storage.

■3 Registering the figures on a screen editor as parts
Figures up to 2000 dots × 1600 dots can be registered as parts.
No figure whose vertical or horizontal size exceeds the above size can be registered.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Shape A
(Height and 
width : 
16 × 16 dots)

Shape B
(Height and
width : 
18 × 18 dots)

Shape C
(Height and
width : 
20 × 20 dots)

The three outer frame lines 
are combined to be looked
like one outer frame line with 
the width of three dots.

Base screen 1
A shape with the line
width of two dots Base screen 15

The base screen 1 isdisplayed 
as a part. 
(The displayed area is across 
two points 1) and 2): The point 1) 
is the upper-left corner of the screen, 
and the point 2) is the lower-right 
corner of the shape on the base screen 1.)

1)

2)

Line A
(Line width: 
One dot)

Line B
(Line width:
 One dot)

Line C
(Line width: 
One dot)

The three lines are combined
to be looked like one line with 
the width of three dots.
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5.9.5 [Parts Image List] window

Displays the list of parts registered in GT Designer3. You can register, edit, or delete parts in the [Parts Image List] 
window.
Select [Common] → [Parts] → [Parts Image List] from the menu to display this dialog.

1) [Register] button
Registers a selected figure as a part.

2) [New Register] button
Registers a new part.

3) [Delete] button
Deletes a selected part.

4) [Cut] button
Cuts a selected part.

5) [Copy] button
Copies a selected part.

6) [Paste] button
Pastes a copied or cut part to a selected area.

7) [Edit] button
Edits a selected part on the parts editor.

8) [Property] button
Changes the number or name of a selected part.

9) Parts image list
Displays the list of the thumbnails, numbers, and names of the registered parts.
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1)

2) 3) 4) 8)7)6)5)

9)
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5.9.6 [Parts Setting] dialog

Sets the display of the parts in the parts display or parts movement.
Select [Common] → [Parts] → [Parts Setting] from the menu to display the [Parts Setting] dialog.

1) [Show overlapping areas of shapes in XOR when Display Mode of Parts Display is XOR]

When the display mode of the parts display or parts movement is set to [XOR], the XOR synthesis is performed to 
all the grouped figures together.

2) [Show image files in the memory card when Parts No. 9001-9999 is specified]
Displays the BMP, JPEG, or PNG parts stored in the parts display or parts movement as parts.

3) [Enable the automatic update of image files]
When an image file stored in drive V is displayed as a part for a parts display, the parts display is updated 
automatically when the image is updated.
For how to display an image file stored in drive V as a part for a parts display, refer to the following.

➟8.8.2 ■5 Switching the image on a parts display object automatically

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

GOT Graphic Ver.1
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6.1 Device Settings

■1 Devices that can be set in GT Designer3 projects
For the types and the ranges of the devices that can be set in GT Designer3 projects, refer to the following.

➟12.1 GOT Internal Device
12.4 Device Range and Settings of Each Controller

■2 Available devices of the target controllers for monitoring
(1) Range of devices that can be set

The range of the devices that can be set in GT Designer3 projects depends on the type of the controller.
For the devices that can be set in controllers of each type, refer to the following.

➟12.4 Device Range and Settings of Each Controller
For how to set the devices, refer to the following.

➟6.1.2 How to set devices

(2) Range of devices that can be set in controllers
The ranges of devices that can be set in GT Designer3 and those available for controllers may differ.
GT Designer3 does not automatically check if the devices set (specified by the names and numbers) in its project can be 
used by the controllers being connected.
To check if the devices can be used by the controllers being connected, follow the instructions shown below.

(a) Checking when setting the controllers
For the types and the ranges of the devices available for the controllers, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

(b) Checking when drawing
For the types and the ranges of the devices that can be set in GT Designer3 projects, refer to the following.

➟12.4 Device Range and Settings of Each Controller

(c) Check with the system alarm.
When you attempt to monitor devices that cannot be used by the controller, by specifying the names or a range, a system 
alarm occurs.
(Alarm: G01-322 Specified device numbers are outside the available range. Check the available range.)

■3 Device setting with labels and tags
Labels and tags are usable in the device setting on GT Designer3.
By using labels and tags, you can create project data without paying attention to the actual devices.
Available labels and tags depend on the system configuration.

(1) System label
The labels can be used only for iQ Works projects.
System labels are intended for use in a large-scale system incorporating Mitsubishi Electric products.

➟6.1.3 How to set system labels

(2) Global label
The labels can be used for connection to the following controllers.

• RCPU*1

• Motion CPU (MELSEC iQ-R series)
• Motion module
• LHCPU

Among the global labels settable in GX Works3, MT Developer2, or Motion Control Setting Function, the GOT can monitor 
the ones that permit access from external devices.

*1 The GOT cannot monitor the global labels of R00CPU, R01CPU, and R02CPU that do not support the settings to permit access 
their labels from external devices.

For setting the global labels, refer to the following.
➟6.1.4 How to set global labels

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) Label (GT Designer3)
The labels can be used only for GT Designer3 projects.
You can use labels (GT Designer3) by assigning devices that can be monitored by the GOT.
Labels (GT Designer3) are usable regardless of the scale of a system configuration.

➟6.1.5 How to set labels (GT Designer3)

(4) OMRON NJ/NX tag
You can use OMRON NJ/NX tags by importing a tag file created with OMRON programming software to GT Designer3.
These tags are intended for use in a system configuration including OMRON PLCs.

➟6.1.7 How to set OMRON NJ/NX tags

(5) RSLogix 5000 tag and AB native tag
You can use these tags by importing tag files created with ALLEN-BRADLEY programming software to GT Designer3.
The tags are intended for use in a system configuration including ALLEN-BRADLEY PLCs.

➟6.1.8 Using RSLogix 5000 tags
6.1.9 How to set AB native tags

(6) OPC UA tag
You can use OPC UA tags by importing the tag information of an OPC UA server to GT Designer3.
The tags are intended for use in a system configuration including OPC UA servers.

➟6.1.10 How to set OPC UA tags

■4 Using device comments and device definitions
By importing device comments and device definitions in GT Designer3, the device comments and device definitions are 
usable in the device setting.

➟6.1.6 Using device comments and device definitions
6. BASIS OF SETTING AND EDITING
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6.1.1 Formats of devices, labels, and tags

The following shows how to format devices, labels, and tags in setting dialogs and scripts.
The formats in setting dialogs and scripts are different.

➟■1 Formats in setting dialogs
■2 Formats in scripts
■3 Device setting for network connection

■1 Formats in setting dialogs
The following shows the formats in the setting dialogs of objects or others.

Example) Channel No. 2, network No. 5, station No. 10, CPU No. 3, and device X0000

The formats in [Device] include the following elements.

Device, label, or tag Format

Device (Channel):(Network setting) (Device)

System label (Label name)

Global label

• For setting the global labels imported from GX Works3 or MT Developer2
(Channel):(Network setting)::(Label name)

• For setting the global labels imported from Motion Control Setting Function
(Channel):(Network setting)::U (Module No.)-(Label name)

Label (GT Designer3) $(Group name):(Label name)

OMRON NJ/NX tag (Channel):(Network setting)::(Tag name)

AB native tag (Channel):(Network setting)::(Tag name)

OPC UA tag (Channel) &(Tag name)

Element Description

Channel

Format @(Channel No.)

Example
Example) Channel No. 2
@2

Explanation
Channel for communicating with a controller.
To specify channel No. 1, "@1:" can be omitted.
If no network setting exists, the colon (:) after "(Channel)" is not required.

Network setting

Format (Network No.)-(Station No.)/(CPU No.)-(Redundant system)

Example
Example) Network No. 5, station No. 10, CPU No. 3, and standby system
5-10/3-S

Explanation

Setting for specifying a network-connected controller.
Enter the following elements as necessary.
• Network No., station No.

To specify the host station or all stations, "(Network No.)-(Station No.)" can be omitted.
However, enter 0-0 to specify all stations for monitoring MODBUS salve equipment.
If no network No. and station No. exist, "(Network No.)-(Station No.)" is not required.
For the monitoring targets when "0" or "FF" is set to the network number and station 
number for network connection, refer to the following.

➟■3 Device setting for network connection
• CPU No.

To specify a CPU No., "(Network No.)-(Station No.)" cannot be omitted.
If no CPU No. exists or you specify CPU No. 0, "/(CPU No.)" is not required.

• Redundant system
To monitor the standby system in a redundant system, enter S.
To monitor the control system in a redundant system or monitor a non-redundant system, 
"-(Redundant system)" is not required.
6 - 4 6. BASIS OF SETTING AND EDITING
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■2 Formats in scripts
The following shows the formats in scripts.

Example) Channel No. 2, network No. 5, station No. 10, CPU No. 3, and device X0000

The formats of channel, network setting, module number, device, label name, and tag name are the same as the formats 
of the elements in [Device] in setting dialogs.

➟6.1.1 ■1 Formats in setting dialogs
Data type is required in scripts.
For its format, refer to the following.

➟9.9.2 ■4 (3) Available devices and how to express the devices

Module No.

Format U (Module No.)

Example
Example) Module No.: A1
UA1

Explanation Set this element to import global labels from Motion Control Setting Function.

Device

Format (Device name)(Device No.).b(Bit position)

Example
Example) Bit 15 of D1000
D1000.b15

Explanation

Device name and device number.
When inserting "(Device)" immediately after "(Network setting)", add a one-byte space 
between them.
To specify a bit of a word device, enter ".b(Bit position)".
Some devices require other elements.
For the formats of such devices, refer to the following.

➟12.4 Device Range and Settings of Each Controller

Label name
Tag name

Format (Label name or tag name).b(Bit position)

Example
Example) Bit 15 of a system label named sys_label_001
sys_label_001.b15

Explanation

Label name or tag name.
To specify a bit of a word device, enter ".b(Bit position)".
The format varies according to the types of labels or tags.
For the details, refer to the following.

➟6.1.3 How to set system labels
6.1.4 How to set global labels
6.1.5 How to set labels (GT Designer3)
6.1.7 How to set OMRON NJ/NX tags
6.1.9 How to set AB native tags
6.1.10 How to set OPC UA tags

Element Description

Device, label, or tag Format

Device [(Channel):(Network setting):(Data type):(Device)]

System label [<t:(Label name)>]

Global label

• For setting the global labels imported from GX Works3 or MT Developer2
[(Channel):(Network setting):(Data type)::(Label name)]

• For setting the global labels imported from Motion Control Setting Function
[(Channel):(Network setting):(Data type)::U (Module No.)-(Label name)]

Label (GT Designer3) [<$:(Group name):(Label name)>]

OMRON NJ/NX tag [(Channel):(Network setting):(Data type)::(Tag name)]

AB native tag [(Channel):(Network setting):(Data type)::(Tag name)]

OPC UA tag [(Channel):(Data type)::&(Tag name)]
6. BASIS OF SETTING AND EDITING
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■3 Device setting for network connection
The following shows the monitored stations when "0" or "FF" is specified for the network number and station number of 
the device.

(1) MELSECNET/H connection

(2) CC-Link IE TSN connection

(3) CC-Link IE Controller Network connection

Specified value Monitored station
Remarks

Network No. Station No. Network No. Station No.

0 (Own network)

0 Own network Control station -

FF (host station) Own network Host station (GOT)
Link devices and GOT internal devices can be 
monitored but the others (transient devices) 
cannot be monitored.

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above Own network As specified -

Same as the GOT

0 As specified Control station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Other than the above 
(different network)

0 As specified Control station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Specified value Monitored station
Remarks

Network No. Station No. Network No. Station No.

0 (Own network)

0 Monitoring unavailable Monitoring unavailable -

FF Own network Host station (GOT) Link devices can be monitored but the others 
(transient devices) cannot be monitored.

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above Monitoring unavailable Monitoring unavailable -

Same as the GOT

0 As specified Master station -

FF Monitoring unavailable Monitoring unavailable -

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Other than the above 
(different network)

0 As specified Master station -

FF Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Specified value Monitored station
Remarks

Network No. Station No. Network No. Station No.

0 (Own network)

0 Own network Control station -

FF (host station) Own network Host station (GOT)
Link devices and GOT internal devices can be 
monitored but the others (transient devices) 
cannot be monitored.

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above Own network As specified -

Same as the GOT

0 As specified Control station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -
6 - 6 6. BASIS OF SETTING AND EDITING
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(4) CC-Link IE Field Network connection

(5) CC-Link connection
For connection to an intelligent device station using the CC-Link connection, set "0" to [NW No.] and the host station 
number to [PC No.] to monitor the RX, RY, RWw, and RWr devices assigned to the master station in the CC-Link 
parameter settings.
To monitor the device of a PLC CPU on other stations, set "0" to [NW No.] and the station number of the relevant station 
(station No.: n) to [PC No.].
(n: Station number of the monitored station (0: Master station, 1 to 64: Local station))

To monitor the RX, RY, RWw, and RWr devices assigned to other stations in the CC-Link parameter settings, apply the 
settings of the host station.
Otherwise, display speed may decrease.

Other than the above 
(different network)

0 As specified Control station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Specified value Monitored station
Remarks

Network No. Station No. Network No. Station No.

0 (Own network)

0 Own network Master station -

FF (host station) Own network Host station (GOT)
Link devices and GOT internal devices can be 
monitored but the others (transient devices) 
cannot be monitored.

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above Own network As specified -

Same as the GOT

0 As specified Master station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Same as the GOT Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Other than the above 
(different network)

0 As specified Master station -

FF (host station) Monitoring unavailable Monitoring unavailable -

Other than the above As specified As specified -

Specified value Monitored station
Remarks

Network No. Station No. Network No. Station No.
6. BASIS OF SETTING AND EDITING
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6.1.2 How to set devices

➟■1 Setting devices in the device setting dialog
■2 Setting devices with the input assist

Set devices in the device setting dialog of each object or with the input assist.
Example) When setting a device to be monitored

■1 Setting devices in the device setting dialog
To set devices, display the device setting dialog from the setting dialog of the object.

Step 1 Click the [...] button in the [Device/Style] tab to display the device setting dialog or the [Select CH No.] dialog.
To display the [Select CH No.] dialog, set multiple controllers and then make the following setting or perform 
the following operation.

• Set [Display only when setting new device] or [Always display] on the [Edit] tab in the [Options] dialog.
➟11.10.4 ■1 [Options] dialog ([Edit] tab)

• Click the [...] button while pressing the [Shift] key of the personal computer.
Step 2 In the [Select CH No.] dialog, select the controller.

Click the controller button to display the device setting dialog.

For the details of the system label, refer to the following.
➟6.1.3 How to set system labels

Step 3 Select the target device in the dialog, and click the [OK] button to set the device for the object.
For details of the settings in the device setting dialog for each controller, refer to the following.

➟12.3 Device Range and Settings of Mitsubishi Electric Equipment
12.4 Device Range and Settings of Each Controller

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device No.
Device name

Station No.
NW No.

CPU No.

@ 2 : 1-5 / 2 D200 . b5
The device being set is displayed.

The channel No. of the controller and name 
of the controller type are displayed.

Channel No.

Bit position
6 - 8 6. BASIS OF SETTING AND EDITING
6.1 Device Settings



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

For the monitoring targets when "0" or "FF" is set to the network number and station number for 
network connection, refer to the following.

➟■3 Device setting for network connection

Step 4 After settings being made in the device setting dialog, the device set in the setting dialog for the object is 
displayed.
For the display by the object setting dialog, refer to the following.

➟12.4 Device Range and Settings of Each Controller
Once a device is set, the device can be set by selecting from the list in the setting dialog of each object from 
the next time.
Up to 5 previously set devices are listed. Subsequently, these are replaced in turn by each successive new 
entry.

■2 Setting devices with the input assist
The target device can be searched in the setting dialog for the object without opening the device setting dialog.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)

The channel No. of the controller and 
name of the controller type being set 
are displayed.
6. BASIS OF SETTING AND EDITING
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6.1.3 How to set system labels

➟■1 Conditions for use of system labels
　 ■2 Applicable system labels
　 ■3 System label setting
　 ■4 System label update/check
　 ■5 Registering system labels
　 ■6 Generating route information on GT Designer3
　 ■7 Precautions for system labels

For iQ Works, system labels can be used instead of setting devices on GT Designer3.
(The system labels cannot be used for applications other than iQ Works.)
The system labels are divided into system label Ver.1 and system label Ver.2.
You cannot use system labels Ver.1 and system labels Ver.2 simultaneously.

• System label Ver.1
The system label Ver.1 is a character string with a controller device assigned.
The system label Ver.1 is shared among the projects in a workspace.

• System label Ver.2
Not available to GT21 and GS21.
The system label Ver.2 is a character string with a global label for GX Works3 or MT Developer2 assigned.
The system label Ver.2 is shared among projects in a workspace.

You can register the both types of system labels in the system label database with GT Designer3.
The system label database is used to manage the system labels.
When a workspace is saved in MELSOFT Navigator, a system label database is created in the workspace.
When no system label database exists in a workspace, system labels cannot be used.

■1 Conditions for use of system labels

(1) Conditions for projects
System labels can be used only a workspace saved in MELSOFT Navigator.
A system label database is not created for a GT Designer3 project in a workspace created by GT Designer3 (not started 
from MELSOFT Navigator). Therefore, the system labels cannot be used.
To use the system labels, save the GT Designer3 project in a workspace created by MELSOFT Navigator.

(2) GOT type setting
To use system labels, select [Use system labels in conjunction with MELSOFT Navigator] in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

(3) Function that does not support the system labels
The system labels cannot be used in the device setting for the MES interface function.
For the MES interface function, specify devices directly.

■2 Applicable system labels

The GOT can use system labels that satisfy the following conditions.
System labels not applicable to the GOT are recognized as incorrect labels.
Those invalid labels can be set in a GT Designer3 project, but cannot be written to the GOT or data storage.

(1) System label name
The GOT can use system labels that satisfy the following conditions.
System labels that do not satisfy the following conditions cannot be set for GT Designer3.

• For the system label Ver.1, the number of characters used in the name of a system label is 32 or less.
• For the system label Ver.2, the number of characters used in the name of a system label is 256 or less.
• One-byte kana characters are not used.
• The following one-byte symbols are not used.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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. , , , [ , ] , : , ! , ", #, $, %, &, ', (, ), *, +, ;, <, =, >, ?, \, ^, `, { , | , } , ~, ?
• A system label name is not the same as a device name.
• Reserved characters are not used.

For reserved characters, refer to the following.
➟GX Works2 Version1 Operating Manual (Common)

(2) Registering system labels in a system label database
System labels that are not registered in a system label database are recognized as incorrect labels.
For how to register the system labels in the system label database, refer to the following.

• Registering system labels by MELSOFT Navigator
➟Help for MELSOFT Navigator

• Registering system labels by GT Designer3
➟■5 Registering system labels

(3) Data types
System labels with the following data types are recognized as incorrect system labels.
Do not set the system labels with the following data types.

• [Time]
• [Pointer]

When [Reflect the data type of label] is selected on the [Edit] tab in the [Options] dialog, the data types of system labels 
are reflected to GT Designer3 settings.

➟11.10.4 Customizing the settings related to editing operations
The following shows the usable data types of system labels.

○: Applicable, -: Not applicable

*1 Available for the following functions.
• Text display object
• Text input object
• Text print object
• Logging function
• Recipe function

Data type of system label Device data type or device type Bit specification of word device

Bit Bit -

Word [Signed]
Signed BIN 16 ○

BCD16 -

Word [Unsigned]/Bit [16bit] Unsigned BIN 16 ○

Double Word [Signed]
Signed BIN 32

-
BCD32

Double Word [Unsigned]/Bit [32Bit] Unsigned BIN 32 -

Timer, Counter, Retentive timer

Current value or setting value Signed BIN 16 -

Contact
Bit -

Coil

Timer [Unsigned], Counter 
[Unsigned], Retentive timer 
[Unsigned]

Current value Unsigned BIN 16 -

Contact
Bit -

Coil

Long timer, Long counter, Long 
retentive timer

Current value Unsigned BIN 32 -

Contact
Bit -

Coil

Single-precision real number Real numbers (32 bits) -

Double-precision real number Real numbers (64 bits) -

String*1

Unsigned BIN 16 or string
-

String [Unicode]*1
6. BASIS OF SETTING AND EDITING
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(4) System label handled as a special structure
GT Designer3 handles the following data types of system labels as special structures.
Although MELSOFT Navigator handles such a label as one, GT Designer3 handles the label as multiple labels.

*1 Only available to MELSEC iQ-R series.
*2 Available to MELSEC iQ-R series and MELSEC iQ-F.

(5) Devices assigned to system labels
Assign devices that can be monitored by the GOT to system labels.
The following system labels are recognized as incorrect labels.

• System labels with devices assigned that cannot be monitored by the GOT
• System labels without devices assigned

Data type of system label Device data type or device 
type Notation of system label Devices of MELSEC-iQ-R/

iQ-F/Q/L Devices of MELSEC-FX

Timer

Signed BIN16
System label name Timer (current value) (TN) Timer (current value) (T)

System label name/V - Timer (set value) (TS)

Bit
System label name/T Timer (contact) (TT) Timer contact (T)

System label name/C Timer (coil) (TC) -

Timer (unsigned)

Unsigned BIN 16 System label name Timer (current value) (TN) -

Bit
System label name/T Timer (contact) (TT) -

System label name/C Timer (coil) (TC) -

Counter

Signed BIN16
System label name Counter (current value) 

(CN) Counter (current value) (C)

System label name/V - Counter (set value) (CS)

Bit
System label name/T Counter (contact) (CT) Counter contact (C)

System label name/C Counter (coil) (CC) -

Counter (unsigned)

Unsigned BIN 16 System label name Counter (current value) 
(CN) -

Bit
System label name/T Counter (contact) (CT) -

System label name/C Counter (coil) (CC) -

Retentive timer

Signed BIN16
System label name Retentive timer (contact) 

(SS) Timer (current value) (T)

System label name/V - Timer (set value) (TS)

Bit
System label name/T Retentive timer (contact) 

(SS) Timer contact (T)

System label name/C Retentive timer (contact) 
(SC) -

Retentive timer (unsigned)

Unsigned BIN 16 System label name Retentive timer (contact) 
(SN) -

Bit
System label name/T Retentive timer (contact) 

(SS) -

System label name/C Retentive timer (coil) (SC) -

Long timer*1

Unsigned BIN 32 System label name Timer (current value) (LTN) -

Bit
System label name/T Timer (contact) (LTN) -

System label name/C Timer (coil) (LTC) -

Long counter*2

Unsigned BIN 32 System label name Counter (current value) 
(LCN) -

Bit
System label name/T Counter (contact) (LCT) -

System label name/C Counter (coil) (LCC) -

Long retentive timer*1

Unsigned BIN 32 System label name Retentive timer (contact) 
(LSN) -

Bit
System label name/T Retentive timer (contact) 

(LSS) -

System label name/C Retentive timer (coil) (LSC) -
6 - 12 6. BASIS OF SETTING AND EDITING
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(6) Global labels assigned to system labels Ver.2
Assign global labels settable in GT Designer3 to system labels Ver.2.
The following system labels Ver.2 are recognized as invalid labels.

• System labels Ver.2 to which global labels that cannot be set in GT Designer3 are assigned
• System labels Ver.2 to which no global labels are assigned

For the conditions of global labels usable in GT Designer3, refer to the following.
➟6.1.4 ■1 Usable global labels

■3 System label setting

As well as devices, system labels are settable in the setting dialog of objects or others.

(1) Entering system label name directly
Enter a system label name in the text box of [Device] in the setting dialog.

The bit specification is available for a system label whose data type is word.
In this case, enter the label name in the following format.

When incorrect label names including a system label name that is not registered in the system label database is entered, 
?? is added to just before the system label name.
Check the system label setting, and then configure the setting again, or register the system label in the system label 
database.

➟6.1.3 ■4 System label update/check

(2) Selecting a system label from the label list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button of [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog to appear varies with the selection 
of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.
For the setting details, refer to the following.
➟11.10.4 Customizing the settings related to editing operations

Step 2 In the [Select CH No.] dialog, click the [System Label] button to display the [Import System Labels to Project] 
dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Enter a system label's name.

System label name
Bit number

sys_label_002. b15

The set device, label, or tag is displayed.

Click this button to set a system label.
6. BASIS OF SETTING AND EDITING
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Step 3 Select a system label from the system label list and click the [Import] button. The selected system label is 
set for [Device].

(3) Setting system labels with the input assist
You can search and set system labels in the setting dialog for the object, without opening the [Import System Labels to 
Project] dialog.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)

■4 System label update/check

Data of a system label database can be edited by each software for iQ Works.
Therefore, system labels used with GT Designer3 settings may not be updated.
When the system label update/check is executed, GT Designer3 project data are updated by importing data in the system 
label database. And then the set system labels are checked whether the labels are applicable.
When registering, changing, or deleting data in the system label database by MELSOFT Navigator or others, execute the 
system label update/check and import the latest system labels.

(1) Operating procedure
Step 1 Select [Tools] → [System Label Update/Check] from the menu to update and/or check system labels.
Step 2 When the system label settings are incorrect, the [System Label Update/Check] dialog appears.

Refer to the following to remove errors.

Select a system label.

Click the button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Works2 
project

MT Developer2 
project

GT Designer3 
project

MELSOFT iQ Works

MELSOFT Navigator

System label 
database

Edit

EditEdit Edit

ImportImport Import

GX Works3 
project

Edit

Import
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1) [Destination System Label List Name]
Select a system label list to which system labels are registered.

2) [Register] button
Registers a system label selected in the error list into the system label database.

➟■5 Registering system labels
3) [Export] button

Exports the result of the system label update/check as a CSV file or a Unicode text file.
4) Error list

Displays error information including the sources of the errors.
For errors, causes, and corrective actions, refer to the following.

➟(5) Error messages
To register an unregistered system label in the system label database, select [Register].

(2) Effect of the system label update/check
When system labels set on GT Designer3 have been deleted from the system label database, they are recognized as 
invalid labels.
When system labels Ver.2 are used, if you change the names of the labels collectively with MELSOFT Navigator, the 
changes are reflected to the names of system labels set in GT Designer3.

(3) Automatically executing the system label update/check
To match a project data and another project data, GT Designer3 automatically executes the system label update/check 
in the following operations.

• Open a GT Designer3 project. (Only when system labels are changed)
• Save a GT Designer3 project.
• Select [Communication] → [Write to GOT] or [Write to Memory Card] from the menu.
• Check or uncheck [Use system labels in conjunction with MELSOFT Navigator] in the [Type Setting] dialog.
• Start or update GT Simulator3.
• The supported model is excluded in the [Controller Setting] dialog.

In the [iQ Works] tab of the [Option] dialog, you can set whether or not to execute the automatic check when initiating a 
GT Designer3 project.
For the setting method, refer to the following.

➟11.10.7 Interaction with iQ Works

(4) System label update notification
When the system labels set for the GT Designer3 project are changed or deleted in the system label database, the system 
label update notification icon is displayed on the status bar.
Right-click the system label update notification icon, and then select [System Label Update/Check] to update and/or 
check system labels.

4)

2) 3)

1)

System label update notification icon
6. BASIS OF SETTING AND EDITING
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(5) Error messages
The following table shows the errors, causes, and corrective actions for the system label update/check.

(6) Update notification icon when using with global labels
If changes in system labels and global labels are notified simultaneously, the system label update notification icon is 
displayed in the status bar.

➟6.1.4 ■2 (3) Notifying and updating a change in the global labels

Error Cause Corrective action

Controller and this project are not allocated in 
MELSOFT Navigator. Allocate this project with 
the controller and save in MELSOFT Navigator.

• The current used project is not assigned to the 
system configuration diagram

• Assign the current used project to the 
controller, and then save the project by 
MELSOFT Navigator

➟Help for MELSOFT Navigator

Device setting of the system label or controller 
setting of GT Designer3 is incorrect. Check the 
device setting of the system label and controller 
setting.

• A device that cannot be monitored by the GOT 
is set.

• The device number of a device set for the 
system label is out of range or invalid.

• Check the device setting of the device 
assigned to the system label.

➟■2 Applicable system labels
12.4 Device Range and Settings of Each 
Controller
Help for MELSOFT Navigator

• A value out of the range is specified for an 
element of array.

• A label name of the structure that does not 
exist is specified.

• /T, /S, or /C is specified for a system label with 
the data type other than [Timer], [Counter], 
and [Retentive Timer].

• Check the data type assigned to the system 
label.

➟Help for MELSOFT Navigator

• A system label with an unavailable channel 
No. is set.

• Check the controller setting for each channel.

➟GOT2000 Series Connection Manual For 
GT Works3 Version1 compatible for a 
controller used

The data type cannot be set in MELSOFT 
Navigator.
Set the data type again.

• A system label with the data type or device 
type not available for the system label is set in 
the setting dialog of an object or others.

• Set a data type or device type available for the 
system label.

➟6.1.3 ■2 (3) Data types
Help for MELSOFT Navigator

Unregistered system label is set. Register it in a 
system label of MELSOFT Navigator.

• A system label that is set for GT Designer3 
does not exist in the system label database.

• Register the system label in the system label 
database.

➟■5 Registering system labels

A system label of unavailable data type is 
selected. Set the device again.

• A system label, whose data type ([Time] or 
[Pointer]) is not available for GT Designer3, is 
set.

• Set a system label with the data type available 
for GT Designer3 to the device setting.

➟■2 Applicable system labels
■3 System label setting
Help for MELSOFT Navigator

The device of the system label cannot be 
obtained. Allocate the device to the system 
label in MELSOFT Navigator.

• The device assigned to the system label Ver.1 
cannot be obtained.

• The global label assigned to the system label 
Ver.2 cannot be obtained.

• Assign a device to the system label Ver.1.
• Assign a global label to the system label Ver.2.

➟Help on MELSOFT Navigator
GX Works3 Operating Manual

The routing information of the system label 
cannot be acquired. Generate the routing 
information of the system label in MELSOFT 
Navigator.

• The route information cannot be obtained with 
MELSOFT Navigator.

• The system configuration diagram of 
MELSOFT Navigator does not match the 
controller setting of the Designer3 project.

• Generate the route information of the system 
label, and then save a workspace.
After saving the workspace, execute the 
system label update/check again.

• Generate the route information of the system 
label by MELSOFT Navigator, and then reflect 
parameters on the GT Designer3 project.

➟Help for MELSOFT Navigator

A system label of string type is set. Export the 
data of corresponding global labels set for the 
system labels from GX Works3 and import it in 
GT Designer3, then select the system label 
again.

• The global labels assigned to the system 
labels Ver.2 of the string type or Unicode string 
type have not been imported to GT Designer3.

• Import the assigned global labels to GT 
Designer3.

• After the import, set the relevant system labels 
Ver.2 again.

➟6.1.4 ■2 Importing global labels
6 - 16 6. BASIS OF SETTING AND EDITING
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■5 Registering system labels

The following procedure shows how to register system labels in the system label database by GT Designer3.
Step 1 Enter a system label name to be registered directly to the text box in [Device] for the dialog box of objects.

Step 2 Select [Tools] → [System Label Update/Check] from the menu to execute the system label update/check 
and list errors in the [System Label Update/Check] dialog.

Step 3 Configure the following settings and click the [Register] button to display a confirmation dialog.
• Check-mark the box in the [Register] column for the system label to be registered.
• In [Destination System Label List Name], select a system label list to register system labels.

Step 4 Click the [Yes] button to register the selected system label to the system label database.
Step 5 Close the [System Label Update/Check] dialog to save the project on GT Designer3.
Step 6 Update the system label list by using MELSOFT Navigator.

When the system label list is not updated, the registered data are not reflected in the system label list.
For how to operate MELSOFT Navigator, refer to the following.

➟Help for MELSOFT Navigator

■6 Generating route information on GT Designer3

(1) Conditions under which the route information is generated
When all the following conditions are satisfied, the route information can be generated by GT Designer3.

• GT Designer3 is started by using MELSOFT Navigator.
• When the project is saved, only a route information obtainment error has occurred at the system label update/check.
Step 1 Save the project data.
Step 2 The confirmation dialog box appears.

Click the [Yes] button to start generating the route information.
Step 3 The route information is generated, and GT Designer3 is displayed at the front.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Click the [Register] button.
Select a system label 
to be registered.

Select a system label list 
to register the selected label.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Operations with which the route information cannot be created
The route information is not generated under the following conditions.

• The project data is saved collectively by using MELSOFT Navigator.
• The project data is saved in the save confirmation dialog box displayed when GT Designer3 exits.
• GT Desiger3 is started by using MELSOFT Navigator, the GOT type is changed, and then the project data is saved.
• The project data is saved while GT Simulator3 is started by using GT Designer3.
• Generating route information takes 20 minutes or more.

■7 Precautions for system labels

(1) Changing a system configuration diagram by MELSOFT Navigator
The route information of the system label is manually generated by the system configuration diagram for MELSOFT 
Navigator.
When changing the system configuration diagram for MELSOFT Navigator, generate the route information again by 
MELSOFT Navigator.
After generating the route information, reflect parameters with the route information on a GT Designer3 project by 
MELSOFT Navigator.
For how to operate MELSOFT Navigator, refer to the following.

➟Help for MELSOFT Navigator

(2) Data type of system labels and data type of devices
When [Reflect the data type of system label] is selected in the [Option] dialog, the data types of system labels are 
reflected to the GT Designer3 settings.
For how to set the items in the [Option] dialog, refer to the following.

➟11.10.7 Interaction with iQ Works

(3) Class for system label
To use a system label with [VAR_GLOVAL_CONSTANT] set for the class, use the system label with a bit device 
assigned. 
When the system label with other than a bit device assigned, the system label is not applicable to GT Designer3.

(4) System label names that can be set for consecutive devices
To set consecutive devices, system label names that are not registered in the system label database cannot be entered.
Enter a system label name that is registered in the system label database.
When you use a system label to specify consecutive devices, the consecutive devices, beginning with the device or the 
device of the global label assigned to the system label, must be within the device range.
Otherwise, you cannot set the system label to specify the consecutive devices in the device setting.

(5) When the system label database is inaccessible
Depending on the version of GT Designer3, the system label database is inaccessible.
If this problem is not solved with the troubleshooting shown in the error message, install the latest version of GT 
Designer3.

(6) Device range when devices are automatically assigned on GX Works2
When devices are automatically assigned to system labels in GX Works2, set the device range that can be monitored by 
the GOT in the automatic device assignment setting.
Otherwise, the GOT may not monitor some of the assigned devices.

➟Help for GX Works2
12.3 Device Range and Settings of Mitsubishi Electric Equipment

(7) Specifying CPU numbers with system labels
System labels cannot be used to specify CPU numbers.

(8) Precautions for using system labels Ver.1
The GOT incorrectly monitors the system labels to which index-modified devices are assigned.
If you set such system labels on GT Designer3, the index modification is invalid.
Example) When you set the system label Ver.1 to which D0Z0 is assigned, the GOT handles D0Z0 as D0.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(9) Precautions for using system labels Ver.2
(a) Importing global labels

Import the global labels that are assigned to the system labels Ver.2 of the string type or Unicode string type.
The system labels Ver.2 may not work properly when the assigned global labels have not been imported.
After the import, set the relevant system labels Ver.2 again.

(b) Station No. switching
The station No. switching is not available to the station that uses system labels Ver.2.
Do not use system labels Ver.2 for the station requiring the station No. switching.

(c) Writing package data
When you set system labels Ver.2 in a project and write the project data to the GOT, [Write Mode] is not selectable in the 
[Write Option] dialog.
In this case, [Write Mode] is fixed to [Synchronize].

➟4.8.3 [Write Option] dialog (for writing data to one GOT)

(d) When using a system label Ver.2 to specify consecutive devices
When you use a system label Ver.2 to specify consecutive devices, the consecutive devices, beginning with the device 
assigned to the label, must be within the device range.
Otherwise, you cannot set the system label Ver.2 to specify the consecutive devices in the device setting.

(10)Updating the system labels used for scripts
The system labels used for scripts cannot be updated by executing the system label update/check.
When you change system labels using MELSOFT Navigator, update the system labels used for scripts by one of the 
following methods.

• Click the [Update] button on the [Option] tab in the [Script] dialog.
➟9.9.5 ■4 [Option] tab

• Select the script in the [Script File List] dialog, click the [Edit Script] button, and then click the [OK] button in the [Edit 
Script(script name)] dialog that appears.

➟9.9.7 [Edit Script(script name)] dialog
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6.1.4 How to set global labels

➟■1 Usable global labels
■2 Importing global labels
■3 Setting global labels
■4 Offset setting for global labels
■5 Performing the label name resolution
■6 Precautions for global labels
■7 [Global Label List] dialog
■8 [Select Global Label] dialog
■9 [Global Label Reference] dialog

You can use global labels for the device setting on GT Designer3.
By using global labels, you can create the project data without paying attention to the actual devices.
The following shows the import sources of global labels.

• GX Works3 project in which global labels are set
• CSV file to which global labels are exported from the label editor of GX Works3, MT Developer2, or Motion Control 

Setting Function
For the details of usable global labels, refer to the following.

➟■1 Usable global labels
For precautions on the use of global labels, refer to the following.

➟■6 Precautions for global labels
The following shows the procedure for setting global labels.

Step 1 Compile global labels with GX Works3, MT Developer2, or Motion Control Setting Function.
Using the global labels without compilation may cause inconsistency in the global label settings between GT 
Designer3 and the controller.
For how to compile global labels, refer to the following.

➟GX Works3 Operating Manual
Help for MT Developer2
Motion Control Setting Function

To import global labels from a GX Works3 project, proceed to step 3.
Step 2 Export global labels from the project created with GX Works3, MT Developer2, or Motion Control Setting 

Function to a CSV file.
For structure-type global labels, export global labels and structures separately to a CSV file.
For how to export global labels, refer to the following.

➟GX Works3 Operating Manual
Help for MT Developer2
Motion Control Setting Function

Step 3 Import the global labels to GT Designer3.

➟■2 Importing global labels
You can check the imported global labels in the [Global Label Reference] dialog.

➟■9 [Global Label Reference] dialog
Step 4 Set the imported global labels to objects or others.

➟■3 Setting global labels
To monitor the device assigned to a global label, the GOT performs the label name resolution at the following timing.

• The GOT starts up. (The GOT is powered on, restarts by reset, or re-runs the project.)
• The GOT detects that the labels used for the controllers are updated.
• The Start Label Name Resolution signal (GS1880.b1) turns on.

For the details of the label name resolution, refer to the following.
➟■5 Performing the label name resolution

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 Usable global labels

(1) Required setting on GT Designer3
To use global labels, set the following model in the [Controller Setting] window.

• [MELSEC iQ-R, RnMT/NC/RT, CR800-D]
• [MELSEC iQ-L]
• [MELIPC]

For the details of [Controller Setting], refer to the following.
➟5.5.1 ■4 [Controller Setting]

(2) Global label setting
Global labels must be created with GX Works3, MT Developer2, or Motion Control Setting Function and have the 
following settings.

For the details of the global label setting, refer to the following.
➟GX Works3 Operating Manual

Help for MT Developer2
Motion Control Setting Function

(3) Array-type global label setting
The array must satisfy the following requirements.

• One-, two-, or three-dimensional array
• For the undefined labels: the subscript for each dimension as shown below

(4) Global label name
The global label name must satisfy the following requirements.
Otherwise, the global label cannot be set on GT Designer3.

• Up to 256 characters are used for a global label name.
Up to 300 characters can be used for the name of a structure of global labels.

• A global label name starts from text or an underscore (_).
• No ASCII line terminator is used.

LF (\n, line feed), CR (\r, carriage return), and CR followed immediately by LF (\r\n)
• No the following space character is used.

ASCII code: SP (space), VT (\v, vertical tabulation), HT (\t, horizontal tabulation), and FF (\f, form feed)
Unicode: fullwidth space (\u3000)

• No the following one-byte symbol is used.
/ \ * ? < > | " : [ ] ; , = + % ' ^ @ { } . ! # $ & ~ ` ( ) -

• No device name, identifier of files, or instruction of sequence programs is used as a global label name.
• No reserved character is used.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Global label export source Required settings

GX Works3 • Access to the labels from external devices is permitted.
• The class is set to VAR_GLOBAL or VAR_GLOBAL_RETAIN.MT Developer2

Motion Control Setting Function The class is set to VAR_GLOBAL or VAR_GLOBAL_RETAIN.

Array Subscript range

One-dimensional array -2147483647 to 2147483647

Two-dimensional array -268435455 to 268435455

Three-dimensional array -262143 to 262143
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(5) Data type of the global label
The following shows the usable primitive data type global labels.

○ : Applicable, -: Not applicable

*1 Available for the following functions.
• Text display object
• Text input object
• Text print object
• Logging function
• Recipe function

(6) Global label handled as a special structure
GT Designer3 handles the following data types of global labels as special structures.
Although GX Works3 or MT Developer2 handles such a label as one, GT Designer3 handles the label as multiple labels.

Data type of global label Data type of device on 
GX Works3

Device data type or device type on GT 
Designer3

Bit specification of word 
device

Bit BOOL Bit -

Word [Signed] INT
Signed BIN16 ○ 

BCD16 -

Word [Unsigned]/Bit [16bit] WORD Unsigned BIN16 ○ 

Double Word [Signed] DINT
Signed BIN32 -

BCD32 -

Double Word [Unsigned]/Bit [32Bit] DWORD Unsigned BIN32 -

Single-precision real number REAL Real numbers (32 bits) -

Double-precision real number LREAL Real numbers (64 bits) -

Timer

Contact TIMER Bit -

Coil TIMER Bit -

Current value TIMER Unsigned BIN16 -

Retentive timer

Contact RETENTIVETIMER Bit -

Coil RETENTIVETIMER Bit -

Current value RETENTIVETIMER Unsigned BIN16 -

Counter

Contact COUNTER Bit -

Coil COUNTER Bit -

Current value COUNTER Unsigned BIN16 -

Long timer

Contact LTIMER Bit -

Coil LTIMER Bit -

Current value LTIMER Unsigned BIN32 -

Long retentive timer

Contact LRETENTIVETIMER Bit -

Coil LRETENTIVETIMER Bit -

Current value LRETENTIVETIMER Unsigned BIN32 -

Long counter

Contact LCOUNTER Bit -

Coil LCOUNTER Bit -

Current value LCOUNTER Unsigned BIN32 -

String*1 STRING
Unsigned BIN 16 or string -

String [Unicode]*1 WSTRING

Data type of global label Notation on GT Designer3 Notation on GX Works2 and MT Developer2

Timer
Counter
Retentive timer
Long timer
Long counter
Long retentive timer

Contact Global label name.S

Global label name
Coil Global label name.C

Current value Global label name.N
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(7) Functions unsupporting the global labels
The global labels cannot be used in the device setting for the MES interface function.
For the MES interface function, specify devices directly.

(8) Using the global label for the setting that requires multiple devices
To set the global label for the setting that requires two or more consecutive devices or multiple devices, use the global 
label whose data type is as follows.

• Array type
• Bit-specified word device
• String
• String [Unicode]

■2 Importing global labels

Import global labels from a project or CSV file.
The import source project must be created with GX Works3.

(1) Importing global labels from a project
Specify a GX Works3 project and import global labels from the project.
Before the import, install GX Works3.
The required GX Works3 version depends on the GX Works3 project used.

If GX Works3 has not been installed, you cannot import global labels.
Step 1 Select [Project] → [Import Other Data] → [Global Label] from the menu to display the [Global Label List] 

dialog.
Step 2 Click the [Add] button to display the [Global Label List] dialog.

Step 3 Specify global labels to be imported.

➟■7 [Global Label List] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Works3 project GX Works3 version

Uncompressed project data Version 1.040S or later

Compressed project data Version 1.050C or later

Security version 2 project data Version 1.095Z or later

Click
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Step 4 Click the [OK] button to import the global labels to the project.

(2) Importing global labels from a CSV file
Specify the CSV files exported from GX Works3, MT Developer2, or Motion Control Setting Function, and import the 
global labels from the files.
To export CSV files from Motion Control Setting Function, the software version must be 1.005F or later.

Step 1 Save CSV files of global labels, which are exported from GX Works3, MT Developer2, or Motion Control 
Setting Function, to the hard disk of the personal computer.
Save CSV files of structure-type global labels to the same folder.

Step 2 Select [Project] → [Import Other Data] → [Global Label] from the menu to display the [Global Label List] 
dialog.

Step 3 Click the [Add] button to display the [Global Label List] dialog.

Step 4 Specify global labels to be imported.

➟■7 [Global Label List] dialog

Step 5 Click the [OK] button to import the global labels to the project.

(3) Notifying and updating a change in the global labels
Check if there is a change in the project or CSV file specified when global labels are imported.
If the project or CSV file has been changed, update the global labels to operate the labels properly.

(a) Target projects and CSV files for detection
The project or CSV file is detected in the following cases.

• When the time stamp is changed
• When the project or CSV file is renamed, deleted, or moved

(b) Timing to check and notify a change
Projects or CSV files are checked when one of the following operations is performed.

• Opening a project
• Displaying the [Global Label List] dialog
• Displaying the [Global Label Reference] dialog
• Displaying the [Select Global Label] dialog
• Clicking the [OK] button in the [Type Setting] dialog
• Clicking the [OK] button or [Apply] button in the [Controller Setting] window
• Clicking the [Finish] button in the [Utilize] dialog to utilize a screen with new controllers

Click
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• Selecting [Communication] → [Write to GOT], [Batch Write to multiple GOTs], or [Write to Memory Card] from the 
menu

When a project or CSV file that has been changed is detected, the change is notified.

(c) Notification method
When a project or CSV file that has been changed is detected, the change is notified by the following methods.

• Notification icon in the status bar
The global label update notification icon appears in the status bar.

Right-click the global label update notification icon, and click the [Update global label data] button to display the 
[Global Label List] dialog.

• [Select Global Label] dialog or [Global Label Reference] dialog
When the dialog is displayed, the message is displayed at the bottom of the dialog.
Example) The [Select Global Label] dialog

(d) Updating the labels
In the [Global Label List] dialog, set the latest project or CSV file.

➟■7 [Global Label List] dialog

(e) Update notification icon when using with system labels
If changes in system labels and global labels are notified simultaneously, the system label update notification icon is 
displayed in the status bar.

➟6.1.3 ■4 (4) System label update notification

Global label update notification icon

Message displayed when there is a change
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■3 Setting global labels

Checking the data type of the global label
When you change the data type of the object device or others, the data types may be inconsistent between the 
global label and the object device or others.
After setting the global label, check if the data types are consistent between the global label and the object device 
or others.
To check the data types, you are recommended to compare the CSV file of global labels with the CSV file 
exported from [Device List] of GT Designer3.

(1) Directly entering the global label name
Enter the global label name in the text box of [Device] in the setting dialog.

For a structure-type global label, add a period (.) and a member name after the structure name.
For an array-type global label, add an element number surrounded by square brackets ([ ]) after the array name.

Example) Global labels set with GX Works3 or MT Developer2

When you enter the global label name directly, the data type consistency check between the global label and the object 
device or others is not performed automatically.
Therefore, the data types may be inconsistent between the global label and the object device or others.

(2) Selecting a global label from the label list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button of [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog to appear varies with the selection 
of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.
For the setting details, refer to the following.
➟11.10.4 Customizing the settings related to editing operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

@2 : 1-5 / 2  : : StopFlg1 . b0  @2 : 1-5  : : U00 - StopFlg1 . b0

Directly entering the global label name

Bit position
Label name
Symbol (::) 
indicating the global label
CPU No.
PLC station No.
NW No.
Channel No.

Bit position
Label name
Module No.
Symbol (::) 
indicating the global label
PLC station No.
NW No.
Channel No.

When setting the global labels 
of GX Works3 or MT Developer2

When setting the global labels 
of Motion Control Setting Function

Structure member name
Structure name
Symbol (::) 
indicating the global label
CPU No.
PLC station No.
NW No.
Channel No.

@2 : 1-5 / 2  : : StopFlg1 . FLG_A
Array element number
Array name
Symbol (::) 
indicating the global label
CPU No.
PLC station No.
NW No.
Channel No.

@2 : 1-5 / 2  : : StopFlg1  [1]
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Step 2 In the [Select CH No.] dialog, click the [Global Label] button to display the [Select Global Label] dialog.

Step 3 Select a global label from the label list and click the [OK] button to set the selected label for [Device].

(3) Using the input assist
Search and set global labels in the setting dialog of the object.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)
When using the input assist, you have to import the global labels in advance.
Import the global labels before setting them.

➟■2 Importing global labels

■4 Offset setting for global labels

The following shows the data types of global labels for which offset setting is available.
• Bit
• Word [Signed]
• Word [Unsigned]/Bit [16bit]
• Double Word [Signed]
• Double Word [Unsigned]/Bit [32Bit]
• Single-precision real number
• Double-precision real number

The offset setting is applied to array element numbers.
Example) Offset setting for an three-dimensional array
For aaa[0..9,0..9,0..9] set for global labels in GT Works3

• First dimension: The start element number is 0, and the number of elements is 10.
• Second dimension: The start element number is 0, and the number of elements is 10.

The set device, label, or tag is displayed.

Click this button to specify a global label.

The channel No. of the controller and
name of the controller type are displayed.
Click this button to set a device.

Select a global label.

Click the button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• Third dimension: The start element number is 0, and the number of elements is 10.

For an array of structures, the offset setting is not applied to the element numbers.
For an array of members of a structure, the offset setting is applied to the element numbers.
Example) Offset setting for a structure

■5 Performing the label name resolution

The label name resolution obtains the devices assigned to global labels from controllers.
The obtained device information is recorded in a label name resolution file.
When the GOT starts up or detects the update of global labels, the GOT obtains the devices assigned to global labels 
from controllers and switches the monitoring devices.

Label name resolution file
The label name resolution file is used to correlate global label names used in the project with device names used 
in the controller.
Referring to the label name resolution file, the GOT identifies the devices assigned to the global labels.

The label name resolution file is created for each channel in the project startup drive at the timing such as the 
first execution of the label name resolution.
Using the GOT utility, you can delete the label name resolution file.
For the deletion method, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(1) Label name resolution methods
Select one of the following methods to resolve label names.

• Batch method
➟(a) Batch method

• Split method
Not available to GT SoftGOT2000.

➟(b) Split method
To switch between the above methods, set [Perform the label name resolution in global label block unit] in the [Global 
Label List] dialog.

➟6.1.4 ■7 [Global Label List] dialog

(a) Batch method
When a global label in a GX Works3 project is updated, the GOT performs the label name resolution on all the global 

Global label set for an object or others Offset device value Offset result

aaa[0.0.1]

8 aaa[0.0.9]

12 aaa[0.1.3]

150 aaa[1.5.1]

352 aaa[3.5.3]

1100 A system alarm occurs due to invalid array subscripts.

Global label set for an object or others Applicability of the offset setting

aaa[0].bbb The offset setting is not applied to an array of structures.

aaa.bbb[0] The offset setting is applied to an array of members of a structure.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Label A D100
Label B D200

：

Line No.1
A 1254

B 348

A 1254

B 348Monitoring label A (D100)
Monitoring label B (D200)

：

Label name 
resolution file

Label A D100
Label B D200

：
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labels in the project.
This method is recommended for use when only one global label block exists in the project or many global label blocks 
are targeted for the label name resolution.
Example 1) When many global label blocks are targeted for the label name resolution, the batch method takes less time 
to complete the resolution as compared with the split method.

Example 2) When a few global label blocks are targeted for the label name resolution, the batch method takes more time 
to complete the resolution as compared with the split method.

GX Works3

Label name

GlobalLabel1

GlobalLabel250

Global label block

Global label block

Label nameGlobal label block

Global label block Label name

GlobalLabel1 Label1_2
Label1_3

GlobalLabel2
Label2_1

GlobalLabel250
Label250_3

Label1_1

LabelLabel X_Y

Label1_1

:

GlobalLabel2

Label2_2
Label2_3

Label250_1
Label250_2

:

Label1_2
Label1_3
Label2_1
Label2_2
Label2_3

Label250_1
Label250_2
Label250_3

: Updated global label

Performing the label 
name resolution

Performing the label 
name resolution
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(b) Split method
When a global label is updated, the GOT performs the label name resolution only on the global label block containing the 
updated label.
This method is recommended for use when a few global label blocks are targeted for the label name resolution.
Example 1) When a few global label blocks are targeted for the label name resolution, the split method takes less time 
to complete the resolution as compared with the batch method.

GX Works3
GlobalLabel1

GlobalLabel250

GlobalLabel1 Label1_2
Label1_3

GlobalLabel2
Label2_1
Label2_2
Label2_3

GlobalLabel250
Label250_1
Label250_2
Label250_3

Label1_1

: :

GlobalLabel2

Label1_1
Label1_2
Label1_3
Label2_1
Label2_2
Label2_3

Label250_1
Label250_2
Label250_3

LabelLabel X_Y

Label name

Global label block

Global label block

Label nameGlobal label block

Global label block Label name

: Updated global label

Performing the label 
name resolution

Performing the label 
name resolution

GX Works3
GlobalLabel1

GlobalLabel1 Label1_2
Label1_3

GlobalLabel2
Label2_1
Label2_2
Label2_3

GlobalLabel250
Label250_1
Label250_2
Label250_3

Label1_1

: :

Label1_1
Label1_2
Label1_3

GlobalLabel2
Label2_1
Label2_2
Label2_3

GlobalLabel250
Label250_1
Label250_2
Label250_3

Label name

Global label block

Global label block

Label nameGlobal label block

Global label block Label name

: Updated global label

Performing the label 
name resolution

LabelLabel X_Y
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Example 2) When many global label blocks are targeted for the label name resolution, the split method takes more time 
to complete the resolution as compared with the batch method.

The split method is usable when one of the following PLC CPUs is connected to the GOT.
If the firmware of the connected PLC CPU does not support the split method, regardless of the setting of [Perform the 
label name resolution in global label block unit], the GOT will perform the label name resolution by the batch method.

Model Firmware version

R04CPU
R08CPU
R16CPU
R32CPU
R120CPU
R04ENCPU
R08ENCPU
R16ENCPU
R32ENCPU
R120ENCPU

Version 40 or later

R08PCPU
R16PCPU
R32PCPU
R120PCPU

Version 28 or later

R08SFCPU
R16SFCPU
R32SFCPU
R120SFCPU

Version 16 or later

L04HCPU
L08HCPU
L16HCPU
L32HCPU

All versions

GX Works3

Label name

GlobalLabel1

GlobalLabel250

Global label block

Global label block

Label nameGlobal label block

Global label block Label name

GlobalLabel1 Label1_2
Label1_3

GlobalLabel2
Label2_1

GlobalLabel250
Label250_3

Label1_1

LabelLabel X_Y

Label1_1

:

GlobalLabel2

Label2_2
Label2_3

Label250_1
Label250_2

:

Label1_2
Label1_3
Label2_1
Label2_2
Label2_3

Label250_1
Label250_2
Label250_3

: Updated global label

Performing the label 
name resolution

Performing the label 
name resolution
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The global labels targeted for the label name resolution vary depending on the conditions under which operations are 
performed on GX Works3.
If all the following conditions are satisfied, the GOT performs the label name resolution only on the global label block 
containing the updated label.
Otherwise, the GOT performs the label name resolution on all the global labels in the project.

• The project is kept open between the instant when it is written to a PLC with [Write to PLC] and the instant when it 
is rewritten to the PLC with [Online Program Change].

• A global label is added to or changed in an existing global label block.
For the operation when a global label is deleted or renamed on the PLC side, refer to the following.

➟6.1.4 ■6 (2) (c) Deleting or renaming a global label

(2) Label name resolution performed automatically
The GOT performs the label name resolution automatically at the following timing.

• The GOT starts up. (The GOT is powered on, restarts by reset, or re-runs the project.)
• The GOT detects that the labels used for the controllers are updated.

(a) When the GOT starts up
The following shows an example of when no label name resolution file exists at the GOT startup.

Step 1 The GOT checks if a label name resolution file exists at startup.
Step 2 If no label name resolution file exists, the GOT performs the label name resolution on all the global labels 

used in the project and creates a label name resolution file.
If a label name resolution file exists, the GOT performs the label name resolution on the unresolved global 
labels in the file.

Step 3 After the label name resolution ends, the GOT starts device monitoring on all the channels.
The GOT stops device monitoring on the channel where the resolution is canceled or not performed.
The GOT cannot monitor the global label that has an error occurred during the resolution.
Accordingly, the object that uses this global label cannot appear on the GOT.
For the resolution results, check the Label Name Resolution Status (Common, CH1 to CH4) (GS1080, 
GS1081 to GS1084).

➟12.1.3 ■3 (57) Label Name Resolution Status (Common, CH1 to CH4) (GS1080, GS1081 to GS1084)

Performing the label name 
resolution and creating 
a label name resolution file

2.

Label name 
resolution file

Line No.1
A 1254

B 348

A 1254

B 348

No label name 
resolution file at 
the GOT startup

Label A: D100
Label B: D200

:

Monitoring 
label A (D100)

Label A: D100

Line No.1
A 1254

B 348

A 1254

B 348

1.

3.
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(b) When the GOT detects the update of global labels

Step 1 The device assigned to the monitored global label is updated from D100 to D200.
Step 2 Upon detecting the global label update on a station, the GOT stops the device update on the station and 

displays a system alarm.
After the label update completes on the PLC side, the GOT performs the label name resolution on the 
station.

Step 3 After the label name resolution ends, the GOT restarts device monitoring.
The GOT cannot monitor the global label that has an error occurred during the resolution.
Accordingly, the object that uses this global label cannot appear on the GOT.
For the resolution results, check the Label Name Resolution Status (Common, CH1 to CH4) (GS1080, 
GS1081 to GS1084).

➟12.1.3 ■3 (57) Label Name Resolution Status (Common, CH1 to CH4) (GS1080, GS1081 to GS1084)

Stopping device monitoring
Detecting the update of 
label A and performing 
the label name resolution

2.

Monitoring 
label A (D100)

Updating label A
D100 to D200

Monitoring 
label A (D200)

Label A: D200

Line No.1
A 1254

B 348

A 1254

B 348

Line No.1
A 1254

B 348

A 1254

B 348

Line No.1
A 1254

B 348

A 1254

B 348

1.

3.
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(3) Label name resolution performed by a user
Turing on the Start Label Name Resolution signal (GS1880.b1) performs the label name resolution.
To monitor the status of the label name resolution, use the Label Name Resolution Status (Common, CH1 to CH4) 
(GS1080, GS1081 to GS1084) simultaneously.

For the details of the Label Name Resolution Control (GS1880) and the Label Name Resolution Status (Common, CH1 
to CH4) (GS1080, GS1081 to GS1084), refer to the following.

➟12.1.3 ■3 (57) Label Name Resolution Status (Common, CH1 to CH4) (GS1080, GS1081 to GS1084)
12.1.3 ■6 (22) Label Name Resolution Control (GS1880)

(4) GOT operation during the label name resolution
Upon starting the label name resolution, the GOT stops monitoring all the channels.
The GOT performs the label name resolution on all the monitored global labels by channel.
The following dialog appears during the resolution.

1) Numbers of resolved label names and errors
The number of resolved label names by channel is displayed.
The number of errors is displayed after the number of resolved label names.

2) [Cancel] button
Cancels the label name resolution.

If an error occurs during the label name resolution, a system alarm occurs after the resolution ends.
Check the system alarm for the details of the error.

➟GOT2000 Series User's Manual (Utility)
The GOT cannot monitor the global label that has an error occurred during the resolution.
Accordingly, the object that uses this global label cannot appear on the GOT.

Start Label Name 
Resolution signal 

(GS1880.b1)

Label name resolution 
process

Label Name Resolution 
Completed (Common)

(GS1080.b2)

Starting the 
label name resolution

Completing 
the label name 
resolution Error

Label Name Resolution 
Error (Common)

(GS1080.b15)

Label Name Resolution 
Canceled (Common)

(GS1080.b3)

Canceling the 
label name resolution

Label Name 
Resolving (Common)

(GS1080.b1)

Turning on upon the 
process start, and 
turning off upon 
the process 
end/cancellation

Turning on upon the 
process end, and 
turning off upon 
the next process start

Turning on upon an error 
occurrence, and turning off 
upon the next process start

Turning on upon the process cancellation, 
and turning off upon the next process start

1)

2)
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(5) Canceling the label name resolution
To cancel the label name resolution, touch the [Cancel] button in the dialog displayed during the resolution.

When the resolution is canceled, the GOT stops monitoring the channels where the resolution is canceled or not 
performed, and turns on the Channel Shutdown Control (CH1 to CH4) (GS539.b0, GS549.b0, GS559.b0, GS569.b0).
To restart monitoring these channels, turn off the Channel Shutdown Control (CH1 to CH4) (GS539.b0, GS549.b0, 
GS559.b0, GS569.b0).

➟12.1.3 ■5 (66) Channel Shutdown Control (CH1 to CH4) (GS539, GS549, GS559, GS569)

■6 Precautions for global labels

(1) Precautions for using global labels
(a) Station No. switching

The station No. switching is not available to the monitored station that uses global labels.
Do not use global labels for the station requiring the station No. switching.

(b) Writing the package data
When you set global labels in a project and write the project data to the GOT, [Write Mode] is not selectable in the [Write 
Option] dialog.
In this case, [Write Mode] is fixed to [Synchronize].

(c) When using a global label to specify consecutive devices
When you use a global label to specify consecutive devices, the consecutive devices, beginning with the device assigned 
to the label, must be within the device range.
Otherwise, you cannot set the global label to specify the consecutive devices in the device setting.

(d) Data type of a global label
The following data types appear incorrectly in the [Global Label Reference] dialog or the [Select Global Label] dialog 
under the following condition: After importing global labels to a project with version 1.170C or earlier of GT Designer3, 
you open the project with the latest version of GT Designer3.

• [Timer]
• [Retentive Timer]
• [Counter]
• [Long Timer]
• [Long Retentive Timer]
• [Long Counter]

In such a case, import the global labels again with the latest version of GT Designer3.

(e) Directly entering a global label name
When the data type of a global label is string or Unicode string, import the label and then set the label by entering its name.
If you do not import the label before setting it, the data type cannot be recognized as string or Unicode string, and a 
system alarm occurs.

(f) Number of characters to be displayed
When you use a global label whose data type is string or Unicode string, set the number of characters to be displayed 
according to the number of characters set with GX Works3.

Touch
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(g) Setting the object or function that uses a global label
Configure the following settings for the object or function that uses a global label whose data type is string or Unicode 
string.

(h) Monitor speed setting
To read or write 235 two-byte characters or more, select [High(Normal)] or [Middle] for [Monitor Speed] in [Detail Setting] 
in the [Controller Setting] window.
If you select [Low] for [Monitor Speed], a system alarm occurs when the data is read or written.

➟5.5.1 ■4 [Controller Setting]

(i) Global label assigned with a device out of the device range
When data is written to the global label that is assigned with a device out of the device range, a system alarm occurs.
Assign a device within the device range to the global label.

(j) Device assigned to a global label
The monitoring speed may decrease depending on whether data types are consistent between the monitored global label 
and the device assigned to the label.
For an array-type global label, assigning a device to an element of the array as shown below may improve the monitoring 
performance.

• When the data type of an element is bit
Assign a bit device to the element.

• When the data type of an element is not bit
Assign a word device to the element.

(k) Specifying CPU numbers with global labels
Global labels cannot be used to specify CPU numbers.

(l) Specifying module numbers with global labels
Global labels cannot be used to specify module numbers.

(m) Global label for a Motion module
If the data type of an array-type global label is specified as bit, a system alarm occurs.
Specify any data type other than bit.

(n) Data types of global labels and consecutive/random device setting
To monitor a primitive data type global label, use the random device setting.
To use the consecutive device setting, set an array-type global label.

(o) Importing GX Works3 project data with security settings configured
When GX Works3 project data with security settings configured is specified at import of global labels, user or project 
authentication may be required.
Perform authentication by entering a user name and password according to the dialog to be displayed.

(2) Precautions for the label name resolution
(a) Differences of whether a label name resolution file exists

In the following cases, the GOT performs the label name resolution on all global labels.
Therefore, the label name resolution may take longer time to complete.

• The GOT has no label name resolution file.
• The GOT has the label name resolution file in which all label names are unresolved.
• The GOT has the label name resolution file that is not created by using the global labels in the project.

(b) Size of a label name resolution file
Using the split method results in a larger label name resolution file as compared with using the batch method.
Reserve enough free space to store the file, and then perform the label name resolution.

Object or function Data type Setting

Text display object, text input 
object

String Deselect [Display in order of High -> Low] in the [Extended] tab.

String [Unicode] Select [Display in order of High -> Low] in the [Extended] tab.

Text print object
String Deselect [Display in order of High -> Low].

String [Unicode] Select [Display in order of High -> Low].

Recipe function, logging function
String Select [High-->Low] for [Storage Order] in the [Device] tab.

String [Unicode] Select [Low-->High] for [Storage Order] in the [Device] tab.
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(c) Deleting or renaming a global label
If a global label on the PLC side is updated with [Online Program Change] of GX Works3, manipulate the relevant label 
on the GOT side as shown below, and then perform the label name resolution.

• When deleting a global label on the PLC side
Delete the relevant global label on the GOT side.

• When renaming a global label on the PLC side
Rename the relevant global label on the GOT side.

(d) Communication timeout during the label name resolution
When the controller communication times out during the label name resolution, the resolution is skipped.
The global labels used for the skipped station are counted as the resolved labels.

(e) Screen switching during the label name resolution
The GOT stops device monitoring on a channel where the label name resolution is being performed.
Therefore, when you switch the screen during the resolution, objects using the devices of the channel cannot appear on 
the destination screen.

(f) Device update during the label name resolution
The GOT stops the device update on a station where the label name resolution is being performed.
When you monitor the station by using object functions, functions running on the GOT background, or others, the latest 
device values are not reflected until the resolution process ends.

➟8. OBJECT FUNCTION
9. FUNCTIONS RUNNING IN THE BACKGROUND

(g) Global labels using a data type of structure
When a structure-type global label has a structure-type member, if you manually assign devices to the child members of 
the structure-type member, the GOT will fail to perform the label name resolution on these child members.
System error 328 occurs.
To solve the above problem, take one of the following corrective actions.

• Perform operations so that the devices are automatically assigned to the members.
• Directly set the manually assigned devices as monitor devices.

The following shows an example where the GOT cannot resolve some label names.
Example) When ST_B is set as the data type of Struct_B that is a member of ST_A on GT Works3
If devices are manually assigned to the labels in ST_B, the GOT cannot resolve these label names.
○: Resolved, ×: Not resolved

Structure A Structure B
[Device] 

(Manually 
assigned)

Result of the 
label name 
resolutionStructure name

[Label Name] 
(Name of a 
member)

[Data Type] (Data 
type of a member) Structure name

[Label Name] 
(Name of a 
member)

[Data Type] (Data 
type of a member)

ST_A

LabelA_1 [Word [Signed]] - - - D10 ○

LabelA_2 [Word [Signed]] - - - D20 ○

Struct_B ST_B(Structure B) ST_B
LabelA_1 [Word [Signed]] D100 ×

LabelA_2 [Word [Signed]] D200 ×
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(h) Corrective action for unresolved label names
The following shows the conditions resulting in unresolved label names.

• The label name resolution is executed during the PLC initial processing.
• The relevant labels are nonexistent on the PLC side.

In both cases, system alarm 328 occurs.
To identify the exact condition resulting in unresolved label names, turn on GS1880.b2 and GS1880.b1 to execute the 
label name resolution.

Condition resulting in unresolved 
label names

Label name resolution result
Corrective action

When GS1880.b2 is off When GS1880.b2 is on

The label name resolution is 
executed during the PLC initial 
processing. Unresolved label names are 

existent.
System error 328 occurs.

The unresolved label names have 
been resolved.
No system alarm occurs.

Change the title display time of the 
GOT so as to execute the label 
name resolution after the PLC 
initial processing.

➟5.3.1 ■2 [Display Setting/
Language Setting]

The relevant labels are 
nonexistent on the PLC side.

Unresolved label names are 
existent.
System error 328 occurs.

Correct the label settings.
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■7 [Global Label List] dialog

You can add, edit, or delete a global label in the [Global Label List] dialog.
To display this dialog, perform one of the following operations.

• Select [Project] → [Import Other Data] → [Global Label] from the menu.
• In the [Project] window, click [Label] and then [Global Label], and double-click [Import/Setting].

1) [Add] button
Displays the [Add Global Label] dialog.
Import global labels.

➟(1) [Add Global Label] dialog or [Edit Global Label] dialog
2) [Edit] button

Displays the [Edit Global Label] dialog.
Edit the settings to import the global labels of the selected file.

➟(1) [Add Global Label] dialog or [Edit Global Label] dialog
3) [Delete] button

Deletes the global labels of the selected file.
4) [Delete All] button

Deletes all global labels.
5) Global label list

Lists the imported global labels and the connected channels.
6) [Perform the label name resolution in global label block unit]

Not available to GT SoftGOT2000.
Performs the label name resolution by the split method.
The label name resolution is performed only on the global label block containing an updated label.
For the details, refer to the following.

➟6.1.4 ■5 (1) Label name resolution methods

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

6)
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3)
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(1) [Add Global Label] dialog or [Edit Global Label] dialog

1) [CH No.]
Select the CH No. for connection to the PLC having the global label setting.

2) [Module Type]
Select [CPU] to specify a project or a CSV file exported from GX Works3 or MT Developer2 in [File Path].
Select [Motion Module] to specify a CSV file exported from Motion Control Setting Function in [File Path].

3) [Network]
Set the network setting for the PLC having the global label setting.

4) [Unit No.]
Set this item to specify a CSV file exported from Motion Control Setting Function in [File Path].
Set the second and third values of the start I/O number of the connected Motion module.
Example) When the start I/O number is 0FE0, set FE to [Unit No.].

5) [File Path]
Specify the path to a project or CSV file from which global labels are imported.

6) [Input Assist Display Column]
For the comment set in the global label, specify the column of the comment to be displayed in the input assist.
If a project is specified with [File Path], the applicable comments are fixed.

7) [Remark]
Set remarks to be displayed in the [Global Label List] dialog.

8) [Preview] button
This item appears only when a project is specified with [File Path].
Displays the [Global Label Preview] dialog showing the details of target global labels.
The global label that cannot be imported is highlighted in gray.
The displayed project data is not editable.

1)

[Add Global Label] dialog

[Edit Global Label] dialog

2)
3)
5)

7)
6)

8)

1)
2)
3)
5)

7)
6)

8)

4)

4)
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■8 [Select Global Label] dialog

You can select a global label from the label list and set the label in the device setting of an object or others in the [Select 
Global Label] dialog.
To display this dialog, click the [Global Label] button in the [Select CH No.] dialog.

1) [Global Label Setting]
Select a combination of the channel number, network setting, module number, and remarks of the imported global 
labels.

2) [Refinement]
Enter characters to narrow down the global labels in the label list.
Only the global labels narrowed down by the entered characters are displayed in the label list.
Up to 32 characters can be entered.
The entered characters are case-insensitive.

3) Search
Search the global label list for a label by the specified keyword.
Set [Search Target] and enter a search keyword in [Keyword].
Click the [Find Next] button to search for a global label by the search keyword.

The following shows the items selectable for [Search Target].
• [All]
• [Label Name]
• [Data Type]
• [Comment]

Up to 32 characters can be entered in [Keyword].
The entered characters are case-insensitive.

4) Global label list
Lists global labels.
Select a global label from the label list and click the [OK] button to set the label for [Device].

5) [Bit Position]
Set the bit position of a global label.
The setting range is [0] to [15].
If you use the [Device List] window to display the [Select Global Label] dialog, [Bit Position] is not settable.

Item Description

[No.] Number of a global label

[Label Name] Name of a global label

[Data Type] Data type of a global label

[Comment] Comment set for a global label

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■9 [Global Label Reference] dialog

The [Global Label Reference] dialog lists the global labels imported to GT Designer3.
To display this dialog, double-click a target global label, or right-click the label and select [Open] from the right-click 
context menu in the [Project] window.

1) [Global Label Setting]
Select a combination of the channel number, network setting, module number, and remarks of the imported global 
labels.

2) [Refinement]
Enter characters to narrow down the global labels in the label list.
Only the global labels narrowed down by the entered characters are displayed in the label list.
Up to 32 characters can be entered.
The entered characters are case-insensitive.

3) Search
Search the global label list for a label by the specified keyword.
Set [Search Target] and enter a search keyword in [Keyword].
Click the [Find Next] button to search for a global label by the search keyword.

The following shows the items selectable for [Search Target].
• [All]
• [Label Name]
• [Data Type]
• [Comment]

Up to 32 characters can be entered in [Keyword].
The entered characters are case-insensitive.

4) Global label list
Lists global labels.

Item Description

[No.] Number of a global label

[Label Name] Name of a global label

[Data Type] Data type of a global label

[Comment] Comment set for a global label

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.1.5 How to set labels (GT Designer3)

➟■1 Specifications of the label (GT Designer3)
　 ■2 Registering, editing, and deleting the label (GT Designer3)
　 ■3 Setting a label (GT Designer3)
　 ■4 Label check
　 ■5 Precautions for labels (GT Designer3)
　 ■6 [Label Group List] dialog
　 ■7 [Label Group] window
　 ■8 [Register to Label] dialog
　 ■9 [Select Label (GT Designer3)] dialog

You can use labels (GT Designer3) for the device setting on GT Designer3.
A label (GT Designer3) is a character string with a device assigned and usable only in GT Designer3 projects.
The GOT internal devices and the devices of Mitsubishi Electric and non-Mitsubishi Electric products can be assigned to 
labels (GT Designer3).
By using labels (GT Designer3), you can create the project data without paying attention to the actual devices.
To create labels (GT Designer3), create a label group first.
By managing the labels (GT Designer3) by label group, you can efficiently perform manipulations on the labels, such as 
editing label names and changing assigned devices.

■1 Specifications of the label (GT Designer3)

(1) Devices that can be assigned to the labels
You can assign devices of the following controllers to the labels (GT Designer3).

• Devices of Mitsubishi Electric products
• Devices of non-Mitsubishi Electric products
• GOT internal devices (excluding gateway devices (EG))

You can set the labels (GT Designer3) without devices assigned on GT Designer3. However, if you write a project having 
such settings to the GOT, the GOT does not operate correctly.
For the details of the controller devices, refer to the following.

➟12.1 GOT Internal Device
12.4 Device Range and Settings of Each Controller

(2) Using different types of labels or tags together
The labels (GT Designer3) can be used together with the following labels and tags.
Select labels or tags as required.

• System label
• Global label
• OMRON NJ/NX tag
• RSLogix 5000 tag
• AB native tag

(3) Label group
A label group is used to classify labels (GT Designer3).
All labels (GT Designer3) are registered in label groups.
Up to 200 label groups can be set for one project.
The numbers or names of the label groups cannot overlap each other.
Set a unique number and name to all label groups.

(4) Number of registrable labels
Up to 204800 labels (GT Designer3) can be registered in one project.
Up to 10000 labels (GT Designer3) can be registered in one label group.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(5) Label name
The label name must satisfy the following requirements.
Otherwise, the label (GT Designer3) cannot be set on GT Designer3.

• A label group contains no labels with the same names.
• Up to 256 characters are used for a label name.
• The following one-byte symbols are not used.

/ \ * ? < > | " : [ ] ; , = + % ' ^ @ { } . ! # $ & ~ ` ( ) -

(6) Data type of the label (GT Designer3)
The following data types are settable for labels (GT Designer3).

○: Applicable, -: Not applicable

*1 The bit specification is not available when a device incapable of being bit-specified is assigned to the label (GT Designer3).

When [Reflect the data type of label] is selected on the [Edit] tab in the [Options] dialog, the data types of labels (GT 
Designer3) are reflected to the settings of objects and others at the time of device specification.

➟11.10.4 Customizing the settings related to editing operations
If you change the data type of a label (GT Designer3) already set to an object or others, the change is not reflected to the 
setting of the object or others.

(7) Array-type label (GT Designer3)
The array must satisfy the following requirements.

• The number of dimensions is three or less.
• (Number of elements in the first dimension) × (Number of elements in the second dimension) × (Number of elements 

in the third dimension) is 2147483648 or less.
➟6.1.5 ■7 (1) [Data Type Selection] dialog

(8) Functions unsupporting the labels (GT Designer3)
The labels (GT Designer3) cannot be used in the device setting for the MES interface function.
For the MES interface function, specify devices directly.

Data type of the label (GT Designer3) Bit specification of word device

[BIT] -

[Signed BIN16] ○*1

[Unsigned BIN16] ○*1

[Signed BIN32] -

[Unsigned BIN32] -

[Signed BIN64] -

[Unsigned BIN64] -

[Signed BIN8] -

[Unsigned BIN8] -

[BCD16] -

[BCD32] -

[BCD64] -

[Real(32bit)] -

[Real(64bit)] -
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(9) Exported file of a label group
The following shows the exported file configuration of a label group.

1) Label group No.
Group No. of the label group.
The setting range is [1] to [200].

2) Label group name
Name of the label group.
Up to 32 characters can be set.

3) Detailed description
Detailed description of the label group.
Up to 512 characters can be set.
A line feed is counted as two characters.

4) [Label Name]
Name of the label (GT Designer3).
Up to 256 characters can be set.

5) [Data Type]
Data type of the label (GT Designer3), and array elements
The array elements are displayed only when the array setting is configured.
Example) When the data type is bit and array elements are set in three dimensions

The following shows the items to be selected for the data type.
• [BIT]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

The setting range of array elements is [-2147483648] to [2147483647].
(Number of elements in the first dimension) × (Number of elements in the second dimension) × (Number of 
elements in the third dimension) must be 2147483648 or less.

6) [Assign (Device)]
Device assigned to the label (GT Designer3).
An invalid device is displayed as [??].

1) 2)

3)

4) 5) 6) 7)

Data type Array element

First
dimension

Second
dimension

Third
dimension
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7) [Comment], [Comment2] to [Comment16]
Comment set for the label (GT Designer3).
Up to 1024 characters can be set.

(10)Labels that can be imported
The following labels can be imported.

• Labels (GT Designer3)
• Global labels created with GX Works3, GX Works2, or MT Developer2 (except structure-type global labels)

■2 Registering, editing, and deleting the label (GT Designer3)

Register labels (GT Designer3) in a label group.
Create a label group in advance, and register the labels (GT Designer3).

(1) Creating a label group
The following shows the procedure for creating a label group.

Step 1 Perform one of the following operations to open the [Label Group Property] dialog.
• Select [Common settings] → [Label] → [Open] from the menu to display the [Label Group List] dialog, 

and click the [New] button.
➟6.1.5 ■6 [Label Group List] dialog

• In the [Project] window, double-click [New] under [Label (GT Designer3)].
Alternatively, right-click [Label (GT Designer3)] and select [New Label Group] from the right-click 
context menu.

➟2.2.4 ■1 [Project] window
Step 2 In the [Label Group Property] dialog, set the label group.

➟6.1.5 ■6 (1) [Label Group Property] dialog

(2) Registering, editing, and deleting a label in the [Label Group] dialog
Step 1 Perform one of the following operations to open the [Label Group] dialog.

• Select [Common settings] → [Label] → [Open] from the menu to display the [Label Group List] dialog. 
In the dialog, select a target label group and click the [Edit] button.

➟6.1.5 ■6 [Label Group List] dialog
• Right-click a target label group in [Label] of the project tree, and select [Open].

➟2.2.4 ■1 [Project] window
Step 2 Register, edit, or delete a label (GT Designer3) in the [Label Group] dialog.

➟■7 [Label Group] window

(3) Utilizing a label (GT Designer3) from a screen
When a screen is created by utilizing screen data from a different project, the label groups set in the source screen are 
selectable.
For how to create a screen by utilizing screen data from a different project, refer to the following.

➟11.4.2 How to use the project utilization

(4) Utilizing a label (GT Designer3) from a template
When a template containing a label (GT Designer3) is dragged and dropped from the library or others, the label also 
comes with the template.

Step 1 Drag and drop a template containing a label (GT Designer3) from the library or others to the screen editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 2 When the template is pasted, the [Register to Label] dialog appears.
Import the labels (GT Designer3).

➟■8 [Register to Label] dialog

When some labels (GT Designer3) listed have the same label group name and label name, but have 
different assigned devices and comments, registration is made as follows:
Consecutive numbers are added to the label names, and the labels are registered as different ones.

(5) Utilizing a label (GT Designer3) from an object
When an object with a label (GT Designer3) set is copied, the label also comes with the object.

Step 1 Open a copy source project and a copy destination project on different GT Designer3 modules.
Step 2 Copy an object with a label set in the source project, and paste the object in the destination project.

If a label (GT Designer3) registered in the copy destination project has the same label group name and label 
name, but has a different assigned device and comment, the following occurs.
The label setting of the source object is not copied, and the setting of the label already registered remains 
effective.
(The rest of the procedure is unnecessary.)

Step 3 Right-click the pasted object, and select [Register to Label].

Drag and drop a template 
containing a label (GT Designer3).

Copy an object.

Copy source projectCopy destination project
6. BASIS OF SETTING AND EDITING
6.1 Device Settings

6 - 47



Step 4 In the [Register to Label] dialog, incorporate the label into the project.

➟■8 [Register to Label] dialog

(6) Importing and exporting a label group
You can import or export a label group by specifying a file as shown below.

• Import
CSV file, Unicode text file, or GX Works3 project

• Export
CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

To import global labels from a GX Works3 project, install GX Works3.
The required GX Works3 version depends on the GX Works3 project used.

Step 1 Perform one of the following operations to open the [Label Group] dialog.
• Select [Common settings] → [Label] → [Open] from the menu to display the [Label Group List] dialog. 

In the dialog, select a target label group and click the [Edit] button.
➟6.1.5 ■6 [Label Group List] dialog

• Right-click a target label group in [Label] of the project tree, and select [Open].
➟2.2.4 ■1 [Project] window

Step 2 Click the [Import] or [Export] button to import or export a label group.

Select the item from 
the right-click context menu.

GX Works3 project GX Works3 version

Uncompressed project data Version 1.040S or later

Compressed project data Version 1.050C or later
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Step 3 In the displayed dialog, perform the import or export operation.
• Import

In the [Import Label] dialog, select a file of labels (GT Designer3) or global labels to be imported, and 
click the [OK] button.

➟6.1.5 ■7 (2) [Import Label] dialog
If [Access from External Device] is enabled for the global labels to be imported, a confirmation dialog 
appears upon clicking the [OK] button in the [Add Global Label] dialog.
To disable the access from external devices and import the labels as the labels (GT Designer3), click 
the [Yes] button in the confirmation dialog.
To display the [Global Label List] dialog, click the [No] button in the confirmation dialog.
The access from external devices remains enabled, and you cannot import the labels as the labels (GT 
Designer3).
To import the labels as global labels, perform the operation in the [Global Label List] dialog.

➟6.1.4 ■7 [Global Label List] dialog
To return to the [Label Group] window, click the [Cancel] button in the confirmation dialog.

• Export
In the [Save As] dialog, set [Save in], [File Name], and [Save as type], and then click the [Save] button.

(7) Registering labels (GT Designer3) automatically
Labels (GT Designer3) are automatically registerable based on the profile (CSP+) data in the personal computer used.
For the details, refer to the following.

➟11.2 Registering the Labels (GT Designer3) Created from Profile Data

■3 Setting a label (GT Designer3)

Checking the data type of the label (GT Designer3)
When you change the data type of the object or others, the data types may be inconsistent between the label 
(GT Designer3) and the object or others.
After setting the label (GT Designer3), check if the data types are consistent between the label (GT Designer3) 
and the object or others.
To check the data types, you are recommended to compare the exported CSV file of a label group with the CSV 
file exported from [Device List].

[Import] button [Export] button

Import Export
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➟11.8.2 Listing devices (Device list)
　 6.1.5 ■2 (6) Importing and exporting a label group

(1) Directly entering a label name
In the setting dialog of an object or others, enter the name of a label (GT Designer3) directly in the text box of [Device].
At the beginning of the name, enter a symbol "$" indicating the label group.
Between the label group name and the label name, enter a delimiter ":".
To specify a bit of the label (GT Designer3) to which a word device is assigned, append a bit number (b0 to b15) to the 
label name.
To enter an array element, enclose the subscripts of the element in a square bracket ([]).
For a multidimensional array, enter a comma (,) to separate the subscripts in each dimension.

(2) Selecting a label (GT Designer3) from the label list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button of [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog to appear varies with the selection 
of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.
For the setting details, refer to the following.
➟11.10.4 Customizing the settings related to editing operations

Step 2 In the [Select CH No.] dialog, click the [Label (GT Designer3)] button to display the [Select Label (GT 
Designer3)] dialog.

Step 3 Select a label (GT Designer3) from the label list and click the [OK] button to set the selected label for 
[Device].

Enter the label name and array element.

Symbol indicating 
the label group

Label group name
Delimiter
Label name
Bit number

$ Line_A : StopFlg1 .b0

Symbol indicating the label group
Label group name
Delimiter
Label name

Array element
(Third dimension, Second dimension, 
 First dimension)

$ Line_A : StopFlg1[0,-10,20]
・Array・Label name

The set device, label, or tag is displayed.

Click this button to specify a label (GT Designer3).

The channel No. of the controller and
name of the controller type are displayed.
Click this button to set a device.
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(3) Using the input assist
When setting a device, you can enter a label (GT Designer3) using the input assist.
Search for and set the label (GT Designer3) in the setting dialog of an object.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)

■4 Label check

The label check function checks set labels (GT Designer3) for errors to correct the errors.
Perform one of the following operations to execute the label check.

• Select [Tool] → [Label Check] from the menu.
• Right-click a target label group in [Label] of the project tree, and select [Open].

➟2.2.4 ■1 [Project] window
In the [Label Check] dialog, correct the errors.

1) [Find Object]
Select the target to be searched in the label check error list.

2) [Find Characters]
Set a character string to be searched for.
The search string is case-insensitive.

3) [Find Next]
Searches the list by the settings of [Find Object] and [Find Characters].

4) Label check error list
Lists errors detected by the label check.

Select a label (GT Designer3).

Click the button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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3)

4)
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You can correct each item in the list.

5) [Register] button
Registers the label (GT Designer3) in the label group.

(1) Error messages, causes, and corrective actions
The following lists messages, causes, and corrective actions for errors detected by the label check.

■5 Precautions for labels (GT Designer3)

(1) Consecutive copy of an object with a label (GT Designer3) set
When you copy an object with a label (GT Designer3) set by using the consecutive copy function, the device number is 
not incremented.
When using the consecutive copy, specify the device directly in the device setting of an object copy.

(2) Changing a label (GT Designer3) in the script text
Even if you change a label name or label group in the [Label Group] dialog, the change is not reflected to the script text 
containing the label.
When using a label (GT Designer3) in the script text, check the script text and change the label setting accordingly.

Item Description

[Error]
Description of the detected error.
➟(1) Error messages, causes, and corrective actions

[Label Group Name] Name of the label group to which the label (GT Designer3) belongs.

[Label Name] Name of the label (GT Designer3). Up to 256 characters can be set.

[Data Type]

Data type of the label (GT Designer3), and array elements The array elements are 
displayed only when the array setting is configured. Example) When the data type is bit 
and array elements are set in three dimensions

[Assign (Device)] Device assigned to the label (GT Designer3). An invalid device is displayed as [??].

[Comment]

Comment set for the label (GT Designer3) where an error occurs. The comment is 
displayed according to the setting of [Input Assist Display] in the [Label Group Property] 
dialog.
➟6.1.5 ■6 (1) [Label Group Property] dialog
Up to 1024 characters can be set.

Data type Array element

First
dimension

Second
dimension

Third
dimension

Error message Cause Corrective action

Unregistered label is set. • A label (GT Designer3) unregistered in the 
label group is set.

• Resister the label (GT Designer3) in the label 
group.

• Delete the label (GT Designer3) if 
unnecessary.

➟■7 [Label Group] window

The array element count is invalid. Register the 
label as a new label or check the setting on the 
Device List, etc. and change the setting.

• After an array-type label (GT Designer3) was 
set for an object or others, the array setting of 
the label was changed in the label list.

• Register the relevant label (GT Designer3) in 
the label group as a new one.

• Correct the array setting of the relevant label 
(GT Designer3).

• Delete the label (GT Designer3) if 
unnecessary.

➟■7 [Label Group] window

Assign (Device) is not set. • A label (GT Designer3) without a device 
assigned is set.

• Assign a device to the label (GT Designer3).

➟■7 [Label Group] window

Invalid device is set for Assign (Device).

• A device of a channel No. that cannot be set is 
assigned to a label (GT Designer3).

• A device that cannot be monitored by the GOT 
is assigned to a label (GT Designer3).

• Assign a valid device to the label (GT 
Designer3).

➟■7 [Label Group] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
6 - 52 6. BASIS OF SETTING AND EDITING
6.1 Device Settings



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

(3) When using a label (GT Designer3) to specify consecutive devices
When you use a label (GT Designer3) to specify consecutive devices, the consecutive devices, beginning with the device 
assigned to the label, must be within the device range.
Otherwise, you cannot set the label (GT Designer3) to specify the consecutive devices in the device setting.
You also cannot use an unregistered label (GT Designer3) to specify consecutive devices.

(4) Utilizing labels (GT Designer3) from a different project
You cannot incorporate labels (GT Designer3) from a different project in the [Utilize Data (Project)] dialog or the [Utilize 
Data (Screen)] dialog.
To utilize a label group from a different project, use [Utilize Project].

➟11.4 Utilizing Other Project Data

(5) When an unregistered label (GT Designer3) is used in the device setting
When you set an unregistered label (GT Designer3) in the device setting for an object, after registering the label in the 
[Label Group] window, close the screen on which the object is placed.
If you edit the label name and the label group name without closing the screen after the registration, the changes are not 
reflected to the object.

(6) Writing package data
When you set labels (GT Designer3) in a project and write the project data to the GOT, [Write Mode] is not selectable in 
the [Write Option] dialog.
In this case, [Write Mode] is fixed to [Synchronize].

➟4.8.3 [Write Option] dialog (for writing data to one GOT)

■6 [Label Group List] dialog

Create, edit, or delete a label group.

1) Label group list
Lists label groups registered in the project.

2) [New] button
Displays the [Label Group Property] dialog to create a label group.

➟(1) [Label Group Property] dialog
3) [Edit] button

Displays the [Label Group] dialog to edit the label group setting and labels (GT Designer3).
➟■7 [Label Group] window

4) [Copy] button
Copies a selected label group.

5) [Paste] button
Pastes a copied label group in the label group list.

• [Destination No.]
Set the number of the label group to be pasted.

• Label group name
Set the name of the label group to be pasted.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6) [Delete] button
Deletes a selected label group.

7) [Delete All] button
Deletes all the label groups in the label group list.

(1) [Label Group Property] dialog

Create or delete a label group.

1) [Group No.]
Set the group No. of the label group.
The setting range is [1] to [200].

2) Label group name
Set the name of the label group.
Up to 32 characters can be set.

3) [Detailed Description]
Set the detailed description of the label group.
Up to 512 characters can be set.
A line feed is counted as two characters.

4) [Multiple Comments Display Setting]
Set comments for the label group.
Up to 16 comments can be set.
The set comments can be used for the input assist.

Item Description

[Input Assist Display] Select comments to be displayed in the input assist.

[Available] Enables the comment title input.

[Comment Title] Set remarks for the comment. Up to 32 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)
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■7 [Label Group] window

Create, edit, or delete a label (GT Designer3) in a label group.
The label group setting is also changeable.

1) [Find Object]
Select the target to be searched in the label (GT Designer3) list.

2) [Find Characters]
Set a character string to be searched for.
The search string is case-insensitive.

3) [Find Next]
Searches the list by the settings of [Find Object] and [Find Characters].

4) Label (GT Designer3) list
Lists labels (GT Designer3) that belong to the label group.

Item Description

[Label Name]

Name of the label (GT Designer3). Up to 256 characters can be set. Click [Label Name] to 
select the column. To select multiple cells in the same column, perform one of the following 
operations.
• Drag the target cells.
• Select the first cell in the range, hold down the [Shift] key and click the last cell in the 

range.
• Select the first cell, hold down the [Shift] key and press an arrow key to extend the 

selection.

[Data Type]

Data type of the label (GT Designer3), and array elements Click a target cell and then click 
the [...] button to display the [Data Type Selection] dialog.
➟(1) [Data Type Selection] dialog
The array elements are displayed only when the array setting is configured. Example) 
When the data type is bit and array elements are set in three dimensions

[Assign (Device)]

Device assigned to the label (GT Designer3). An invalid device is displayed as [??]. Click 
[Assign (Device)] to select the column. To select multiple cells in the same column, perform 
one of the following operations.
• Drag the target cells.
• Select the first cell in the range, hold down the [Shift] key and click the last cell in the 

range.
• Select the first cell, hold down the [Shift] key and press an arrow key to extend the 

selection.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5) [Insert Row] button
Inserts a row above a selected row in the label (GT Designer3) list.

6) [Cut] button
Cuts a row, column, or cell selected in the label (GT Designer3) list.
Note that a cell in the [Data Type] column cannot be cut alone.
You can paste the cut data on another text editing application (such as Microsoft Excel and Notepad).

7) [Copy] button
Copies a row, column, or cell selected in the label (GT Designer3) list.
You can paste the copied data on another text editing application (such as Microsoft Excel and Notepad).

8) [Paste] button
Pastes a copied row, column, or cell to the location specified in the label (GT Designer3) list.
You can also copy or cut data that is created with a text editing application (such as Microsoft Excel and Notepad), 
and paste the data to the label (GT Designer3) list.
However, you cannot paste data to multiple columns at once.

9) [Delete] button
Deletes a row, column, or cell selected in the label (GT Designer3) list.
Note that a cell in the [Data Type] column cannot be deleted alone.

10) [Label Group Property] button
Displays the [Label Group Property] dialog to change the label group setting.

➟6.1.5 ■6 (1) [Label Group Property] dialog
11) [Import] button

Imports a label group from a CSV file, Unicode text file, or GX Works3 project.
Set the file to be imported in the [Import Label] dialog.

➟(2) [Import Label] dialog
12) [Export] button

Exports the label group to a CSV file or Unicode text file.
Set the file to be exported in the [Save As] dialog.

13) [Batch Edit] button
Displays the [Batch Edit] dialog to collectively change the label group, channel, or network settings of rows selected 
in the label (GT Designer3) list.

➟(3) [Batch Edit] dialog

[Comment], [Comment2] to [Comment16]

Comments for the label (GT Designer3). Up to 1024 characters can be set. Click 
[Comment] or [Comment2] to [Comment16] to select the corresponding column. To select 
multiple cells in the same column, perform one of the following operations.
• Drag the target cells.
• Select the first cell in the range, hold down the [Shift] key and click the last cell in the 

range.
• Select the first cell, hold down the [Shift] key and press an arrow key to extend the 

selection.

Item Description
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(1) [Data Type Selection] dialog

1) [Data Type]
Select the data type of the label (GT Designer3).
The following shows the items to be selected.

• [Bit]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

2) [Array]
Set the array for the label (GT Designer3).

Item Description

[Setting Option]
Select the method of specifying the array. The following shows the items to be selected.
• [Element Count]
• [Range]

[Element (1)], [Element (2)], [Element (3)]

When [Element Count] is selected for [Setting Option], the number of array elements in each 
dimension is settable. (The smallest subscript for each dimensions is always 0.) The setting 
range is [1] to [2147483648]. (Number of elements in the first dimension) × (Number of 
elements in the second dimension) × (Number of elements in the third dimension) must be 
2147483648 or less.

[Element (1)], [Element (2)], [Element (3)]

When [Range] is selected for [Setting Option], the lower and upper bounds of each dimension 
are settable. The setting range is [-2147483648] to [2147483647]. (Number of elements in the 
first dimension) × (Number of elements in the second dimension) × (Number of elements in the 
third dimension) must be 2147483648 or less.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

When [Setting Option] is set to [Element Count]

When [Setting Option] is set to [Range]
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(2) [Import Label] dialog

1) [Label Type]
Select the type of labels to be imported.
The setting of [Controller Type] in the [Controller Setting] window determines the selectable items.
○: Selectable ×: Not selectable

2) [CH No.]
This item is settable when [Label Type] is set to [Global Label (GX Works2)], [Global Label (GX Works3)], or [Label 
(MT Developer2)].
Select the channel number of the controller that uses labels (GT Designer3) or global labels.

3) [Network Setting]
This item is settable when [Label Type] is set to [Global Label (GX Works2)], [Global Label (GX Works3)], or [Label 
(MT Developer2)].
Set the network for the controller that uses labels (GT Designer3) or global labels.
For GT21 and GS21, this item is not settable if [Controller Type] is set to [MELSEC-QnA] or [MELSEC-A] in the 
[Controller Setting] window.

4) [File Path]
Specify the path to a CSV file, Unicode text file, or GX Works3 project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

When [Label Type] is set to [Label (GT Designer3)] When [Label Type] is set to [Global Label (GX Works2)], 
[Global Label (GX Works3)], or [Label (MT Developer2)]

4)

4)

2) 3)

[Controller Type]
[Label Type]

[Label (GT Designer3)] [Global Label (GX 
Works2)]

[Global Label (GX 
Works3)] [Label (MT Developer2)]

[MELSEC iQ-R, RnMT/
NC/RT, CR800-D] (GT27, 
GT25, GT23, GT 
SoftGOT2000, GS25)
[MELSEC iQ-R, RnMT/
RT, CR800-D] (GT21 and 
GS21)

○ × ○ ○

[MELSEC iQ-L] ○ × ○ ×

[MELSEC iQ-F] ○ × ○ ×

[MELSEC-Q/QS, Q17nD/
M/NC/DR/DSR, CRnD-
700] (GT27, GT25, GT23, 
GT SoftGOT2000, GS25)
[MELSEC-Q, Q17nD/M/
DR/DSR, CRnD-700] 
(GT21 and GS21)

○ ○ × ○

[MELSEC-QnA, MELDAS 
C6*] ○ ○ × ×

[MELSEC-QnA] ○ ○ × ×

[MELSEC-L] ○ ○ × ×

[MELSEC-A] ○ ○ × ×

[MELSEC-FX] ○ ○ × ×

[MELIPC] ○ × ○ ○
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(3) [Batch Edit] dialog

Collectively change the settings of the labels (GT Designer3) selected in the label (GT Designer3) list in the [Label Group] 
window or the [Register to Label] dialog.

1) [CH No.]
This item cannot be set in the following cases.

• No devices are assigned to all the selected labels (GT Designer3).
• GOT internal devices are assigned to all the selected labels (GT Designer3).

The channel numbers of the labels (GT Designer3) are changed collectively.
Select the channel number to be changed to.

2) [Network Setting]
This item cannot be set in the following cases.

• Devices of different controllers are assigned to the selected labels (GT Designer3).
• No devices are assigned to all the selected labels (GT Designer3).
• GOT internal devices are assigned to all the selected labels (GT Designer3).

The network settings of the labels (GT Designer3) are changed collectively.
Click [...] and configure the network setting in the [Network Setting] dialog.
The setting contents depend on the controller. Refer to the descriptions of the device setting dialog for each 
controller.

➟12.4 Device Range and Settings of Each Controller
3) [Label Group Name]

This item can be set only when this dialog is opened in the [Register to Label] dialog.
The label group names of the labels (GT Designer3) are changed collectively.
Select a label group name.

4) [Replace] button
Collectively reflects the setting changes made in this dialog to the labels (GT Designer3) selected in the [Label 
Group] window or the [Register to Label] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■8 [Register to Label] dialog

The labels (GT Designer3) set for an object and others are listed. Register unregistered labels (GT Designer3) in label 
groups.

1) [Find Object]
Select the target to be searched in the label (GT Designer3) list.

2) [Find Characters]
Set a character string to be searched for.
The search string is case-insensitive.

3) [Find Next]
Searches the list by the settings of [Find Object] and [Find Characters].

4) List of labels (GT Designer3)
Lists the labels (GT Designer3) set in the project.
The names of labels (GT Designer3) unregistered in label groups are shown in red.

5) [Cut] button
Cuts a selected row from the label (GT Designer3) list.

6) [Copy] button
Copies a selected row in the label (GT Designer3) list.

7) [Paste] button
Pastes a copied row in the label (GT Designer3) list.

8) [Batch Edit] button
Displays the [Batch Edit] dialog to collectively change the label group, channel, or network settings of rows selected 
in the label (GT Designer3) list.

Item Description

[Label Group Name] Name of the label group. Up to 32 characters can be set.

[Label Name] Name of the label (GT Designer3). Up to 256 characters can be set.

[Data Type]

Data type of the label (GT Designer3), and array elements The array elements are 
displayed only when the array setting is configured. Example) When the data type is bit 
and array elements are set in three dimensions

[Assign (Device)] Device assigned to the label (GT Designer3). An invalid device is displayed as [??].

[Comment]

Comment for the label (GT Designer3). The comment is displayed according to the setting 
of [Input Assist Display] in the [Label Group Property] dialog.
➟6.1.5 ■6 (1) [Label Group Property] dialog
Up to 1024 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟6.1.5 ■7 (3) [Batch Edit] dialog
9) [Register] button

Registers the labels (GT Designer3) in label groups.

■9 [Select Label (GT Designer3)] dialog

You can select a label (GT Designer3) from the label list and set the label in the device setting of an object or others in 
the [Select Label (GT Designer3)] dialog.
To display this dialog, click the [Label (GT Designer3)] button in the [Select CH No.] dialog.

1) [Label Group]
Select a label group to be displayed in the label (GT Designer3) list.

2) [Refinement]
Enter characters to narrow down the labels (GT Designer3) in the label list.
Only the labels (GT Designer3) narrowed down by the entered characters are displayed in the label list.
Up to 32 characters can be entered.
The entered characters are case-insensitive.

3) Search
Search the label (GT Designer3) list for a label by the specified keyword.
Set [Search Target] and enter a search keyword in [Keyword].
Click the [Find Next] button to search for a label (GT Designer3) by the search keyword.

The following shows the items selectable for [Search Target].
• [All]
• [Label Name]
• [Data Type]
• [Assign (Device)]
• [Comment]

Up to 32 characters can be entered in [Keyword].
The entered characters are case-insensitive.

4) Label (GT Designer3) list
Lists the labels (GT Designer3) of the label group selected in [Label Group].
Select a label (GT Designer3) from the label list and click the [OK] button to set the label for [Device].

Item Description

[No.] Number of a label (GT Designer3)

[Label Name] Name of a label (GT Designer3)

[Data Type] Data type of a label (GT Designer3)

[Assign (Device)] Device assigned to a label (GT Designer3)

[Comment] Comment set for a label (GT Designer3)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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5) [Bit Position]
Set the bit position of a label (GT Designer3).
The setting range is [0] to [15].
If you use the [Device List] window or the [Edit Script (script name)] dialog to display the [Select Label (GT 
Designer3)] dialog, [Bit Position] is not settable.
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6.1.6 Using device comments and device definitions

➟■1 Importing device comments and device definitions
■2 Referring to device comments and device definitions
■3 Precautions for device comments and device definitions
■4 [Device Comment / Device Definition List] dialog
■5 Device comment setting dialog
■6 Device definition setting dialog

You can retrieve the following device comments and device definitions for the device setting on GT Designer3.
• Device comments of a MITSUBISHI ELECTRIC PLC or MELIPC
• Device definitions of a MITSUBISHI ELECTRIC servo amplifier, inverter, or others

While checking the details of devices in a sequence program or others, you can set the devices on GT Designer3, 
avoiding setting incorrect device numbers.

To retrieve the device comments, select the MITSUBISHI ELECTRIC PLC for [Controller Type] in the controller setting.
To retrieve the device definitions, select a MITSUBISHI ELECTRIC servo amplifier, inverter, or others for [Controller 
Type] in the controller setting.

■1 Importing device comments and device definitions

Import device comments and device definitions to refer to devices with GT Designer3.
Step 1 Select [Project] → [Import Other Data] → [Device Comment/Device Definition] from the menu.
Step 2 The [Device Comment/Device Definition] dialog is displayed.

Set device comments or device definitions to be used.
➟■4 [Device Comment / Device Definition List] dialog

Step 3 Click the [OK] button to complete importing.

(1) Destination for device comment data
Device comment data (***.csv) of GX Works2 is created in the destination specified when the device comment is 
exported.
Device comment data (***.wcd) of GX Developer is created in the project of GX Developer.

(2) Data of GX Developer to be used
Data of GX Developer that is necessary to use this function is only device comment data (***.wcd).
The other projects of GX Developer are not needed.

(3) If device comments are corrected using GX Works2 or GX Developer
The device comments that have been set in a GT Designer3 project are not updated automatically.
To update the comments, click the [OK] button in the [Device Comment/Device Definition] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Works2 project

Import

GT Designer3 project

Devices can be set while the device No. being used 
by GX Works2 is checked.
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(4) Set device comments and device definitions
They are saved in the project and retained.

■2 Referring to device comments and device definitions

Set device comments and device definitions to be retrieved with the setting dialog or input assist.

(1) Setting device comments and device definitions to be retrieved with the dialog for selecting
Step 1 In the device setting dialog, click the [Switch to the device comment dialog] button or [Switch to the device 

define dialog] button.

Step 2 The setting dialog for device comments or device definitions appears.
Search devices to be used and set them.

➟6.1.6 ■5 Device comment setting dialog
　 6.1.6 ■6 Device definition setting dialog

Step 3 Click the [OK] button after the settings to complete the device settings.

(2) Setting device comments and device definitions to be retrieved using the input assist
Device comments and device definitions can be searched and set in the setting dialog for the object without opening the 
setting dialog for device comments or device definitions.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)

■3 Precautions for device comments and device definitions
(1) Restriction by the project security

Users who are prohibited to edit by the security for the whole project cannot import device comments, device definitions, 
and tag files.
For the project security, refer to the following.

➟2.13 Protecting a Project by Registering Users

(2) Changing storage location of tag files
If the storage location of the tag files has been changed after tag files were imported, update the tag files and set the path 
to the new storage location.
If the path is not changed, the tag files are not displayed in the tag view when device settings are made.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Device Comment / Device Definition List] dialog

Select [Project] → [Import Other Data] → [Device Comment/Device Definition] from the menu to display the setting dialog.

Device definitions describe the uses of servo amplifier devices and inverter devices.
For the correspondences between the devices used in the GOT and the data of a servo amplifier or inverter, refer to the 
following.

➟12.4 Device Range and Settings of Each Controller
1) [Add] button

Displays the [Add Device Comment / Device Definition] dialog.
Add the device comments or device definitions to be retrieved.

➟(1) [Add Device Comment / Device Definition] dialog or [Edit Device Comment / Device Definition] dialog
2) [Edit] button

Displays the [Edit Device Comment / Device Definition] dialog.
Edit the settings to import the device comments or device definitions of the selected controller.

➟(1) [Add Device Comment / Device Definition] dialog or [Edit Device Comment / Device Definition] dialog
3) [Delete] button

Deletes selected device comments or device definitions.
4) [Delete All] button

Deletes all device comments or device definitions.

(1) Changing the GOT type
After the GOT type being changed, if the CH No. set in the [Device Comment / Device Definition List] dialog 
cannot be used by the newly set GOT type, the device comments and device definitions of the CH No. are 
deleted.

(2) Changing the controller model
If the controller model is changed, the device comments and device definitions of the CH No., for which the 
previous model is set, are deleted.

(3) Device definitions for which [Network Setting] is set to [0-0]
If a MITSUBISHI ELECTRIC servo amplifier is selected for [Controller Type] in the controller setting, the 
device definitions for which [Network Setting] is set to [0-0] are added automatically.
The device definitions can be retrieved in the device definition setting dialog or by the input assist, but cannot 
be updated and deleted because they are not displayed in the list in the [Device Comment / Device Definition 
List] dialog.
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(1) [Add Device Comment / Device Definition] dialog or [Edit Device Comment / Device Definition] dialog

1) [CH No.]
Select the channel number of the controller having the device comments or device definitions to be added.

2) [Network Setting]
Specify the network of the controller having the device comments or device definitions to be added.

3) [Controller]
Set this item only for connection to an inverter.
Select the controller having the device comments or device definitions to be added.

4) [Device Comment], [Device Definition]
Set the file necessary to use the device comments.
If a MITSUBISHI ELECTRIC servo amplifier or inverter is selected with [CH No.], this setting is unnecessary.

• GX Works3, GX Works2: CSV file into which the device comment is exported
• GX Developer: Device comment file

5) [Input Assist Display Column]
Specify the column of the device comment to be displayed in the input assist.

6) [Remark]
Set remarks to be displayed in the [Device Comment / Device Definition List] dialog.
Up to 200 characters can be set.
When the device comments of GX Works2 are imported, the project name of GX Works2 is set.

7) [Register the device comments as a comment group], [Register the device definitions as a 
comment group]
Registers the imported device comments or device definitions as a comment group.
Set the destination comment group number in [Comment Group No.].
The setting range is [1] to [500].
The data of [Remark] is set to the comment group name.
Up to 32 characters can be used for the comment group name, and the 33rd or later characters are not used.

8) [Register the device names as well]
Registers the device names to the comment group, together with the device comments or the device definitions.
The device names are added to column No.30 in the comment group where the device comments are registered.

1)

Adding device comments Editing the settings for the device comments

Adding device definitions Editing the settings for the device definitions

2)

3)
4)

4)
5)
6)

7)

7)
8)

8)

6)

2)
1)
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■5 Device comment setting dialog

In the device setting dialog, click the [Switch to the device comment dialog] button to display the device comment setting 
dialog.

1) [Text Search]
Select the range (category) of the character string and type the character string to search the target device 
comment.
The following shows the items to be selected.

• [Device]
• [Comment]
• [Machines]

2) Device comment list
Displays the device comments that match the search criteria.

3) [Switch to the device setting dialog] button
Switches the display to the device setting dialog.

Searching the buffer memory
If any of the following items has been selected for [Controller Type] in the [Controller Setting] dialog, the buffer 
memory cannot be searched in the dialog for selecting device comments.

• [MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700] (GT27, GT25, GT23, GT SoftGOT2000, GS25)
• [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700] (GT21 and GS21)
• [MELSEC-QnA, MELDAS C6*]
• [MELSEC-L]
• [MELSEC-FX]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■6 Device definition setting dialog

In the device setting dialog, click the [Switch to the device define dialog] button to display the device definition setting 
dialog.

1) Search method
Select the method of searching.

2) Device definition list
Displays the device definitions that match the search criteria.

3) Changing the address
The device number or axis number of each set device definition is changeable.
This item appears when [Controller Type] is set to one of the following items in the [Controller Setting] window and 
the selected device definition is available.

• [MELSERVO-J5(W)-*G(-RJ), -JET-*G]
• [FREQROL 800]
• [FREQROL 800/E700NE(Batch monitor)]
• [IAI ROBO CYLINDER]
• [IAI X-SEL Controller]
• [Azbil DMC50]

The setting range differs depending on the device.
4) [Switch to the device setting dialog] button

Switches the display to the device setting dialog.

Item Description

[Function Name Search] Select a function to search the target device. Depending on the controller, the setting range 
differs.

[Text Search]

Select the range (category) of the character string and type the character string to search 
the target device comment. The following shows the items to be selected.
• [Definition]
• [Symbol]
• [Device]
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6.1.7 How to set OMRON NJ/NX tags

➟■1 Usable OMRON NJ/NX tags
■2 Requirements for OMRON NJ/NX tags
■3 Offset setting for OMRON NJ/NX tags
■4 Importing a tag file
■5 Setting an OMRON NJ/NX tag
■6 Precautions for OMRON NJ/NX tags
■7 [OMRON NJ/NX Tag List] dialog
■8 [Select OMRON NJ/NX Tag] dialog

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
You can import the OMRON NJ/NX tags created with OMRON programming software to GT Designer3.
The imported OMRON NJ/NX tags are usable in the device setting.
Using OMRON NJ/NX tags enables you to create project data without paying attention to the actual devices.

For the usable OMRON NJ/NX tags, refer to the following.
➟■1 Usable OMRON NJ/NX tags

For the precautions on using OMRON NJ/NX tags, refer to the following.
➟■6 Precautions for OMRON NJ/NX tags

The following shows the procedure for specifying an OMRON NJ/NX tag in the device setting.
Step 1 Create OMRON NJ/NX tags with OMRON programming software.

For the procedure for creating an OMRON NJ/NX tag, refer to the following.
➟OMRON programming software manual

Step 2 Export the created OMRON NJ/NX tags.
The contents of the exported OMRON NJ/NX tags are copied to the clipboard.
For the procedure for exporting the tags, refer to the following.

➟OMRON programming software manual
Step 3 Paste the copied contents from the clipboard to a text file, and save the file in Unicode text format.
Step 4 Import the tag file in Unicode text format to GT Designer3.

➟■4 Importing a tag file
Step 5 In the device setting, specify an OMRON NJ/NX tag of the imported tag file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Designer3

Personal computer

Tag file

Unicode text formatOMRON programming 
software
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Export the created 
OMRON NJ/NX tags 
to a Unicode text file.

Import the tag file in Unicode 
text format to GT Designer3.

In the device setting, 
specify an 
OMRON NJ/NX tag 
of the imported tag file.
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➟■5 Setting an OMRON NJ/NX tag

■1 Usable OMRON NJ/NX tags

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
You can import the OMRON NJ/NX tags created with OMRON programming software to GT Designer3.
The imported OMRON NJ/NX tags are usable for the channel whose [Controller Type] is set to [OMRON NJ/NX] in the 
controller setting.
For the above channel, only OMRON NJ/NX tags and GOT internal devices are usable in the device setting.

(1) Specifications of the tag file
You can import the tag files created for the following PLCs to GT Designer3.

(2) Supported software
You can import the tag files created with the following programming software to GT Designer3.

(3) Tag file format
Create tag files in Unicode text format.
You cannot import the tag files in any other file format to GT Designer3.

(4) Importable pieces of data
Importable pieces of data is 204800 per tag file.

■2 Requirements for OMRON NJ/NX tags

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

(1) Tag name and structure name
The tag name or structure name must satisfy the following requirements.

• A name consists of alphanumeric characters (A to Z, a to z, and 0 to 9), one-byte katakana, multibyte characters, 
and underscores (_).

• The length of a tag name is 127 bytes or less.
Up to 300 characters can be set for a structure name.

However, the names containing the following combinations of characters are unusable.
• A name begins with a number (0 to 9).
• A name ends with an underscore (_).
• Underscores (_) are used successively in a name.
• A name begins or ends with a space.

(2) Data type
The following shows the usable data types.
○: Applicable, -: Not applicable

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC type Model

OMRON PLC

NJ series NJ501-1500, NJ501-1400, NJ501-1300, NJ501-1520, NJ501-1420, NJ501-1320, NJ501-
1340, NJ301-1200, NJ301-1100, NJ101-1000, NJ101-9000, NJ101-1020, NJ101-9020

NX series
NX1P2-1140DT, NX1P2-1140DT1, NX1P2-1040DT, NX1P2-1040DT1, NX1P2-9024DT, 
NX1P2-9024DT1, NX701-1700, NX701-1600, NX102-1200, NX102-1100, NX102-1000, 
NX102-9000

Manufacturer Software Software version

OMRON Corporation Sysmac Studio 1.00 or later

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Data type of OMRON NJ/NX tag Device data type or device type on GT Designer3 Bit specification of word device

BOOL Bit -

BYTE
Signed BIN8 -

Unsigned BIN8 -
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*1 Available for the following functions.
• Text display object

WORD

Signed BIN16 ○

Unsigned BIN16 ○

BCD16 -

DWORD

Signed BIN32 -

Unsigned BIN32 -

BCD32 -

Real(32bit) -

LWORD

Signed BIN64 -

Unsigned BIN64 -

BCD64 -

Real(64bit) -

SINT
Signed BIN8 -

Unsigned BIN8 -

INT

Signed BIN16 ○

Unsigned BIN16 ○

BCD16 -

DINT

Signed BIN32 -

Unsigned BIN32 -

BCD32 -

Real(32bit) -

LINT

Signed BIN64 -

Unsigned BIN64 -

BCD64 -

Real(64bit) -

USINT
Signed BIN8 -

Unsigned BIN8 -

UINT

Signed BIN16 ○

Unsigned BIN16 ○

BCD16 -

UDINT

Signed BIN32 -

Unsigned BIN32 -

BCD32 -

Real(32bit) -

ULINT

Signed BIN64 -

Unsigned BIN64 -

BCD64 -

Real(64bit) -

REAL

Signed BIN32 -

Unsigned BIN32 -

BCD32 -

Real(32bit) -

LREAL

Signed BIN64 -

Unsigned BIN64 -

BCD64 -

Real(64bit) -

STRING *1 String -

Data type of OMRON NJ/NX tag Device data type or device type on GT Designer3 Bit specification of word device
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• Text input object
• Text print object
• Logging function
• Recipe function

(3) Using an OMRON NJ/NX tag for the setting that requires multiple devices
To set an OMRON NJ/NX tag for the setting that requires consecutive or separate devices, use an OMRON NJ/NX tag 
whose data type is as follows.

• Structure
• String
• Array
• Bit specification of word device

(4) Structure-type OMRON NJ/NX tags
Tags of a structure that consist of members of the following data types are usable.

• Boolean
• Bit string
• Integer
• Real
• String
• Array specification
• Enumeration

For an enumeration-type tag, when a tag name is directly entered, reading the value of the tag is available.
For data type and device type, select [Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)].

➟6.1.7 ■5 (1) Directly entering a tag name

(5) Union type OMRON NJ/NX tags
Union-type tags of a structure that consist of members of the following data types are usable.

• Boolean
• Bit string

(6) Enumeration type OMRON NJ/NX tags
When a tag name is directly entered, reading the value of the tag is available.
For data type and device type, select [Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)].

➟6.1.7 ■5 (1) Directly entering a tag name

(7) Array-type OMRON NJ/NX tags
The array must satisfy the following requirements.

• One-, two-, or three-dimensional array
• Any data type other than string
• For the undefined tags: the subscript for each dimension as shown below

Array Subscript range

One-dimensional array 0 to 65535

Two-dimensional array 0 to 65535

Three-dimensional array 0 to 65535
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■3 Offset setting for OMRON NJ/NX tags

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
For an array-type tag, the offset setting is applied to the element numbers.
Example) Offset setting for an OMRON NJ/NX tag in Tag[4,4,4]

For the tags of a structure, if the structure is set as an array element, the offset setting is not applied to the tags.
For the array-type tags of a structure, the offset setting is applied to the tags.
Example) Offset setting for the OMRON NJ/NX tags of a structure

■4 Importing a tag file

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
The following shows the procedure for importing a tag file to GT Designer3.

Step 1 Select [Project] → [Import Other Data] → [Tag] → [OMRON NJ/NX Tag] from the menu.
Step 2 The [OMRON NJ/NX Tag List] dialog appears.

➟■7 [OMRON NJ/NX Tag List] dialog

■5 Setting an OMRON NJ/NX tag

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

Checking the data type of an OMRON NJ/NX tag
If you change the data type of an object or others, the data types may be inconsistent between the set OMRON 
NJ/NX tag and the object or others.
After setting an OMRON NJ/NX tag, check if the data types are consistent between the tag and the object or 
others.

OMRON NJ/NX tag set for an object or others Offset device value Offset result

Tag[0,1,1]

2 Tag[0,1,3]

-1 Tag[0,1,0]

5
Tag[0,2,1]
(As the row number of the element tag is changed, a 
system alarm occurs if Tag[4,4,4] has not been imported.)

119 A system alarm occurs due to invalid array subscripts.

OMRON NJ/NX tag set for an object or others Offset result

STRUCT01[1].INT01 The offset setting is not applied to the tags of a structure that is set as an array element.

STRUCT01.INT02[1] The offset setting is applied to the array-type tags of a structure.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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To check the data type consistency, you are recommended to compare the used tag file with the file exported 
from [Device List] of GT Designer3.

(1) Directly entering a tag name
Enter an OMRON NJ/NX tag name directly in the textbox of [Device] in the setting dialog of an object or others.
At the beginning of the tag name, add a "::" symbol indicating the tag.

When you enter the tag name directly, the data type consistency check between the OMRON NJ/NX tag and the object 
or others is not performed automatically.
The data types may be inconsistent between the OMRON NJ/NX tag and the object or others.

(2) Selecting an OMRON NJ/NX tag from the tag list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button of [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog to appear varies with the selection 
of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.
For the setting details, refer to the following.

➟11.10.4 Customizing the settings related to editing operations
Step 2 In the [Select CH No.] dialog, click the [OMRON NJ/NX Tag] button to display the [Select OMRON NJ/NX 

Tag] dialog.

Step 3 Select an OMRON NJ/NX tag from the tag list and click the [OK] button to set the tag in [Device].

Directly entering the tag name

Bit position
Tag name
Symbol (::) indicating the tag
PLC station No.
NW No.
Channel No.

@2 : 1-3  : : WORD_1 . b0

The set device, label, or tag is displayed.

The channel No. of the controller and 
name of the controller type are displayed.
Click this button to set a device.

Click this button to specify an OMRON NJ/NX tag.
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(3) Using the input assist
Search for an OMRON NJ/NX tag to set the tag in the setting dialog of an object or others.
For information on how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)
When using the input assist, you must import OMRON NJ/NX tags in advance.
Import the OMRON NJ/NX tags before setting them.

➟■4 Importing a tag file

■6 Precautions for OMRON NJ/NX tags

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

(1) OMRON NJ/NX tag name
When you use multiple OMRON NJ/NX tags whose names are long, the monitoring process may take a longer time.

(2) Tag settings in a project read from the GOT
When a project containing OMRON NJ/NX tags is read from the GOT, check the tags in the [OMRON NJ/NX Tag List] 
dialog.
If a tag file is displayed in red, import the tag file again.

(3) Directly entering an OMRON NJ/NX tag name
For a string-type OMRON NJ/NX tag, import the tag and enter the tag name to specify it.
If you do not import the tag before setting it, the data type cannot be recognized as string, and a system alarm occurs.

(4) Importing an identically-named OMRON NJ/NX tag of a different data type
After an OMRON NJ/NX tag is set in the project, if you import an identically-named OMRON NJ/NX tag of a different data 
type, the set tag may be displayed as [??].
If [??] is displayed, set the relevant OMRON NJ/NX tag again.

(5) Setting the object or function that uses an OMRON NJ/NX tag
Configure the following settings for the object or function that uses a string-type OMRON NJ/NX tag.
• Text display object, text input object
Select [Display in order of High -> Low] in the [Extended] tab.

• Text print object
Select [Display in order of High -> Low].

• Recipe function, logging function
Select [Low-->High] for [Storage Order] in the [Device] tab.

(6) Character code
The GOT uses UTF-16 encoding, and the OMRON NJ or NX series uses UTF-8 encoding.
When you use a string-type OMRON NJ/NX tag, perform encoding conversion (between UTF-16 and UTF-8) and then 
write or read the tag.
The string length in bytes varies with the encoding format.

Select an OMRON NJ/NX tag.

Click the button.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• UTF-16
One character takes two bytes.

• UTF-8
One character takes one to three bytes.
A null (one byte) is appended to a string.

As the length of a string in UTF-16 differs from that of the string in UTF-8, an OMRON NJ/NX tag may not be written or 
read properly.
Set the number of characters to be displayed and the number of bytes for a string-type OMRON NJ/NX tag with 
consideration of the string length difference between UTF-16 and UTF-8.

(7) Startup time setting
If data is written to or read from an OMRON NJ/NX tag immediately after the OMRON NJ or NX series is turned on, a 
system alarm may occur.
In such a case, specify a longer time after which the GOT start communicating with the OMRON NJ or NX series by 
setting [Startup Time(Sec)] of the [Detail Setting] dialog in the controller setting.

➟12.15.5 [Detail Setting] dialog

(8) Station No. switching while an OMRON NJ/NX tag is being used
The station No. switching is not available to the station using an OMRON NJ/NX tag.
Do not use an OMRON NJ/NX tag for the station requiring the station No. switching.

(9) Number of characters of the comment set for an OMRON NJ/NX tag
For an OMRON NJ/NX tag, set a comment in 1024 characters or less.
The 1025th and subsequent characters are not displayed on GT Designer3.

(10)Bit specification of a word device assigned to an OMRON NJ/NX tag
The GOT reads the value of the device in word units, then writes a value to the device in bit units.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

■7 [OMRON NJ/NX Tag List] dialog

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
To display this dialog, select [Project] → [Import Other Data] → [Tag] → [OMRON NJ/NX Tag] from the menu.

1) [Add] button
Displays the [Add Tag] dialog.
Import an OMRON NJ/NX tag file.

➟(1) [Add Tag] dialog or [Edit Tag] dialog
2) [Edit] button

Displays the [Edit Tag] dialog.
Edit the settings of the selected tag file.

➟(1) [Add Tag] dialog or [Edit Tag] dialog
3) [Delete] button

Deletes a selected tag file.
4) [Delete All] button

Deletes all tag files.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
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2)
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5) Tag file list
Lists the imported OMRON NJ/NX tag files and the connected channels.

(1) [Add Tag] dialog or [Edit Tag] dialog

1) [CH No.]
Select the channel number of the PLC having the OMRON NJ/NX tag setting.

2) [Network Setting]
Specify the network of the PLC having the OMRON NJ/NX tag setting.

3) [Tag]
Specify the path to a Unicode text file of OMRON NJ/NX tags.

4) [Remark]
Set remarks to be displayed in the [OMRON NJ/NX Tag List] dialog.

■8 [Select OMRON NJ/NX Tag] dialog

Not available to GT2105-Q.
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
In the [Select OMRON NJ/NX Tag] dialog, select an OMRON NJ/NX tag from the tag list to set the tag in the device setting 
of an object or others.
To display this dialog, click the [OMRON NJ/NX Tag] button in the [Select CH No.] dialog.

1)

[Add Tag] dialog

[Edit Tag] dialog

2)
3)
4)

1)
2)
3)
4)
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2)
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1) [OMRON NJ/NX Tag Setting]
Select a combination of the channel number, network setting, and remarks of the imported OMRON NJ/NX tags.

2) [Refinement]
Enter characters to narrow down the OMRON NJ/NX tags in the tag list.
Only the OMRON NJ/NX tags narrowed down by the entered characters are displayed in the tag list.
Up to 32 characters can be entered.
The entered characters are case-insensitive.

3) Search
Search the OMRON NJ/NX tag list for a tag by the specified keyword.
Set [Search Target] and enter a search keyword in [Keyword].
Click the [Find Next] button to search for the next occurrence of the keyword.

The following shows the items selectable for [Search Target].
• [All]
• [Tag Name]
• [Data Type]
• [Comment]

Up to 32 characters can be entered in [Keyword].
The entered characters are case-insensitive.

4) OMRON NJ/NX tag list
Lists the OMRON NJ/NX tags.
Select an OMRON NJ/NX tag from the tag list and click the [OK] button to set the tag in [Device].

5) [Bit Position]
Set the bit position of an OMRON NJ/NX tag.
The setting range is [0] to [15].
If the [Select OMRON NJ/NX Tag] dialog has been brought up from the [Device List] dialog, [Bit Position] is not 
settable.

Item Description

[No.] Number of an OMRON NJ/NX tag

[Tag Name] Name of an OMRON NJ/NX tag

[Data Type] Data type of an OMRON NJ/NX tag

[Comment] Comment set for an OMRON NJ/NX tag
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6.1.8 Using RSLogix 5000 tags

➟■1 Importing a tag file
■2 Referring to RSLogix 5000 tags
■3 [RSLogix 5000 Tag List] dialog
■4 Tag list dialog (RSLogix 5000 tag)

Not available to GT2105-Q.
You can import RSLogix 5000 tags, which are created with ALLEN-BRADLEY programming software, to GT Designer3.
The imported RSLogix 5000 tags are usable in the device setting.

The following shows the procedure for setting RSLogix 5000 tags to devices.
Step 1 Create RSLogix 5000 tags with ALLEN-BRADLEY programming software.

For how to create RSLogix 5000 tags, refer to the following.
➟ALLEN-BRADLEY programming software manual

Step 2 Export the created RSLogix 5000 tags in the CSV format.
For the procedure for exporting tags, refer to the following.

➟ALLEN-BRADLEY programming software manual
Step 3 Import the tag files which were created in the CSV format to GT Designer3.

➟■1 Importing a tag file
Step 4 Set the RSLogix 5000 tags in the imported tag file to devices.

➟■2 Referring to RSLogix 5000 tags

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Designer3

Personal computer

Tag file 
(CSV)

ALLEN-BRADLEY 
programming software

INT 3 64Exporting the created 
RSLogix 5000 tags

Importing the CSV tag file 
to GT Designer3

Setting an RSLogix 5000 
tag contained in the tag 
file to a device
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■1 Importing a tag file

The following shows the procedure for importing tag files to GT Designer3.
Step 1 Select [Project] → [Import Other Data] → [Tag] → [RSLogix 5000 Tag] from the menu.
Step 2 Add, delete, or edit tag files in the [RSLogix 5000 Tag List] dialog.

➟■3 [RSLogix 5000 Tag List] dialog

(1) Specifications of the tag file
(a) Supported PLC

GT Designer3 can import tag files which are created for the following PLCs.

(b) Supported software
You can import tag files, which are created with the following programming software, to GT Designer3.

(c) Supported tag
You can import only controller tags with GT Designer3.
Program tags cannot be imported.

(2) Requirements for creating tag files
The following explains the requirements for creating tag files with RSLogix 5000.

(a) Tag mapping
Map the created RSLogix 5000 tags.
Tags without mapping cannot be set in devices using GT Designer3.

(b) Tag file format
Create tag files in the CSV format.
GT Designer3 cannot import tag files in formats other than the CSV format.

(c) Composition of tag files
To import tag files to GT Designer3, the following settings are required.
Set the following fields with RSLogix 5000.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC type Model

ALLEN-BRADLEY PLC
ControlLogix series

1756-L, 1756-L1M1, 1756-L1M2, 1756-L1M3, 1756-L61, 1756-L62, 1756-L63, 1756-L64, 
1756-L55M12, 1756-L55M13, 1756-L55M14, 1756-L55M16, 1756-L55M22, 1756-
L55M23, 1756-L55M24

CompactLogix series 1769-L31, 1769-L32E, 1769-L32C, 1769-L35E, 1769-L35CR

Manufacturer Software

Rockwell Automation, Inc. (ALLEN-BRADLEY) RSLogix 5000

Field Description Input example

TYPE
Set the type of the target records.
Set the type TAG: the tag type that can be read to GT Designer3 
is only the type TAG.

TAG

SCOPE Leave blank. -

NAME
Set a tag name.
The setting range is 0 to 40 character (s).

tagBOOL
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■2 Referring to RSLogix 5000 tags

The following shows the procedure for setting imported tags into devices.
Step 1 Click the [Switch to the tag list dialog] button from the device setting dialog.

Step 2 In the tag list dialog (RSLogix 5000 tag), set the RSLogix 5000 tag to be used.

➟■4 Tag list dialog (RSLogix 5000 tag)

Step 3 Click the [OK] button to complete the RSLogix 5000 tag setting.

DESCRIPTION
Set the comment of the tag in ASCII characters.
The setting range is 0 to 120 character (s).

$0050$004C$0043

DATATYPE

Set the data type and the element number.
The setting range of the element number depends on the data 
type.
• INT, DINT, REAL: The setting range is [0] to [1000].
• BOOL: The setting range is [32] to [32000].

The element number must be set in multiples of 32.

BOOL[32]

SPECIFIER Leave blank. -

ATTRIBUTES

Set the attribute.
RADIX PLCMappingFile or PLC2Mapping can be selected.
If this field is PLCMappingFile, set the file number.
The setting range of the file number is 0 to 999.

(PLCMappingFile := 100)

Field Description Input example

(PLCMappingFile := 100)

File number

Attribute

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [RSLogix 5000 Tag List] dialog

Select [Project] → [Import Other Data] → [Tag] → [RSLogix 5000 Tag] from the menu to display the setting dialog.

1) Tag file list
The tag files which have been imported to GT Designer3 appear in a list.

2) [Add] button
Displays the [Add Tag List] dialog.
Add a tag file to the tag file list.

3) [Edit] button
Displays the [Edit Tag List] dialog.
Edit the settings of the selected tag file.

4) [Delete] button
Deletes a selected tag file.

5) [Delete All] button
Deletes all the tag files from the tag file list.

• [Tag List Name] Set the tag list name for the tag file to be added.
• [CSV File] Set the path to the tag file to add.

• [Tag List Name] Displays the tag list name before the edit.
• [CSV File] Displays the tag list name before the edit.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)

2)

4)
5)
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■4 Tag list dialog (RSLogix 5000 tag)

Click the [Switch to the tag list dialog] button in the device setting dialog to display the tag list dialog.

1) [Search Target]
Select the target item for searching in the tag view.
The following shows the items to be selected.

• [Display]
• [Tag Name]
• [Data Type]
• [Device Name]
• [Comment]

2) [Find Text]
Set a character string to search.
This search operation is case-insensitive.

3) [Find Next] button
Searches by the settings in [Search Target] and [Find Text].

4) Tag file list
The tag files which have been imported to GT Designer3 appear in a list.

5) Tag view
Displays the contents of a selected tag file in a list.

6) [Bit Position]
Set a bit position.
The setting range is [0] to [15].

7) [Network]
Set the station No. of the destination controller for monitoring.
[Host] or [Other] can be set.
When selecting [Other], set [Network No.] and [Station No.].

8) [Switch to the device setting dialog] button
Switches to the device setting dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3)
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5)
6. BASIS OF SETTING AND EDITING
6.1 Device Settings

6 - 83



6.1.9 How to set AB native tags

➟■1 Usable AB native tags
■2 Importing a tag file
■3 Setting AB native tags
■4 Precautions for AB native tags
■5 [AB Native Tag List] dialog
■6 [Select AB Native Tag] dialog

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
You can import AB native tags, which are created with ALLEN-BRADLEY programming software, to GT Designer3.
The imported AB native tags are usable in the device setting.
By using AB native tags, you can create the project data without paying attention to the actual devices.

For the details of usable AB native tags, refer to the following.
➟■1 Usable AB native tags

For precautions on the use of AB native tags, refer to the following.
➟■4 Precautions for AB native tags

The following shows the procedure for setting AB native tags to devices.
Step 1 Create AB native tags with ALLEN-BRADLEY programming software.

For how to create AB native tags, refer to the following.
➟ALLEN-BRADLEY programming software manual

Step 2 Output the created AB native tags to an L5K, L5X, or CSV file.
The output method depends on the file format.
For the details, refer to the following.

➟ALLEN-BRADLEY programming software manual
Step 3 Import the outputted tag file to GT Designer3.

➟■2 Importing a tag file
Step 4 Set the AB native tags contained in the imported tag file to devices.

➟■3 Setting AB native tags

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Designer3

Personal computer

Tag file

ALLEN-BRADLEY 
programming software

INT 3 64

Outputting the created
 AB native tags to a file.

Importing the tag file to 
GT Designer3.

Setting an AB native 
tag contained in the tag
 file to a device

Date type: 
            L5K, L5X, or CSV
6 - 84 6. BASIS OF SETTING AND EDITING
6.1 Device Settings



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

■1 Usable AB native tags

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
You can import AB native tags, which are created with ALLEN-BRADLEY programming software, to GT Designer3.
The imported AB native tags are usable for the channel whose [Controller Type] is [AB Control/CompactLogix(Tag)] in 
the controller setting.
For the channel whose [Controller Type] is [AB Control/CompactLogix(Tag)], only AB native tags and GOT internal 
devices are usable in the device setting.
To use controller devices in the device setting, do not select [AB Control/CompactLogix(Tag)] for [Controller Type].

(1) Specifications of the tag file
GT Designer3 can import tag files which are created for the following PLCs.

(2) Supported software
You can import tag files, which are created with the following programming software, to GT Designer3.

(3) Tag file format
Create tag files in one of the following formats.

• L5K
• L5X
• CSV

If created in any formats other than the above, the tag files cannot be imported to GT Designer3.

(4) Required setting for AB native tags
(a) External access

To use AB native tags, select an item other than [None] for the external access.

(b) Scope
The AB native tags must be defined as follows.

(c) Tag name and structure name
Tag names and structure names must satisfy the following requirements.

• A name consists of one-byte alphanumeric characters (A to Z, a to z, 0 to 9) and underscores (_).
• A name begins with a one-byte alphanumeric character (A to Z, a to z) or an underscore (_).
• Up to 40 characters are set for a tag name.

Up to 300 characters can be set for a structure name.
• Underscores (_) are not used successively in a name.
• A tag name does not end in an underscore (_).

(d) Tag type
The following types of tags can be used.

• Alias tags
• Base tags
• Produced tags
• Consumed tags

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC type Model

ALLEN-BRADLEY PLC

ControlLogix5000 series
1756-L, 1756-L1M1, 1756-L1M2, 1756-L1M3, 1756-L55M12, 1756-L55M13, 
1756-L55M14, 1756-L55M16, 1756-L55M22, 1756-L55M23, 1756-L55M24, 
1756-L61, 1756-L62, 1756-L63, 1756-L64, 1756-L72S, 1794-L33, 1794-L34

ControlLogix 5580 series 1756-L81E, 1756-L82E, 1756-L83E, 1756-L84E, 1756-L85E

CompactLogix series 1769-L32E, 1769-L35E

Manufacturer Software Software version

Rockwell Automation, Inc. (ALLEN-BRADLEY) RSLogix 5000
L5K: 10, 11, 12, 13, 15, 20, 32
L5X: 20, 32
CSV: 13 or later

Scope Description

Controller (global data) Controller tags. Direct access to the tags is available. The tags are not output to the 
[SCOPE] column of a CSV file.
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For the details, refer to the following.
➟ALLEN-BRADLEY programming software manual

(e) Data type
You can use the AB native tag whose data type is as follows.

○: Supported, -: Unsupported

*1 Only available to ControlLogix 5580 series.

(f) Using the AB native tag for the setting that requires multiple devices
To set the AB native tag for the setting that requires two or more consecutive devices or multiple devices, use the AB 
native tag whose data type is as follows.

• Structure
• String
• Array

Data type of AB native tag Device data type or device type on GT 
Designer3 Bit specification of word device

BOOL Bit -

SINT
Signed BIN8

-
Unsigned BIN8

INT

Signed BIN16
○

Unsigned BIN16

BCD16 -

DINT

Signed BIN32
○

Unsigned BIN32

BCD32
-

Real numbers (32 bits)

LINT

Signed BIN64

-
Unsigned BIN64

BCD64

Real numbers (64 bits)

REAL

Signed BIN32
○

Unsigned BIN32

BCD32
-

Real numbers (32 bits)

USINT*1
Signed BIN8

-
Unsigned BIN8

UINT*1

Signed BIN16
○

Unsigned BIN16

BCD16 -

UDINT*1

Signed BIN32
○

Unsigned BIN32

BCD32
-

Real numbers (32 bits)

ULINT*1

Signed BIN64

-
Unsigned BIN64

BCD64

Real numbers (64 bits)

LREAL*1

Signed BIN64

-
Unsigned BIN64

BCD64

Real numbers (64 bits)
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• Bit specification of word device

(g) Constant value
The AB native tags specified as constants (True) are not usable.

(h) Structure-type AB native tags
The data type of a structure must be as follows.

• String
• Predefined data type
• Module-defined data type
• User-defined data type

The string-type AB native tags are usable for the following functions.
• Text display object
• Text input object
• Text print object
• Logging function
• Recipe function

(i) Array-type AB native tags
The array must satisfy the following requirements.

• One-, two-, or three-dimensional array
• For the BOOL data type: one-dimensional array

(However, for the BOOL undefined tags, one-, two-, or three-dimensional arrays are usable.)
• For the undefined tags: the subscript for each dimension as shown below

■2 Importing a tag file

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
The following shows the procedure for importing tag files to GT Designer3.

Step 1 Select [Project] → [Import Other Data] → [Tag] → [AB Native Tag] from the menu.
Step 2 Add, delete, or edit tag files in the [AB Native Tag List] dialog.

➟■5 [AB Native Tag List] dialog

Array Subscript range

One-dimensional array 0 to 2147483647

Two-dimensional array 0 to 268435455

Three-dimensional array 0 to 262143

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Setting AB native tags

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

Checking the data type of the AB native tag
When you change the data type of the object device or others, the data types may be inconsistent between the 
AB native tag and the object device or others.
After setting the AB native tag, check if the data types are consistent between the AB native tag and the device 
of an object or others.
To check the data type consistency, you are recommended to compare the tag file created with RSLogix 5000 
with the file exported from [Device List] of GT Designer3.

(1) Directly entering the tag name
Enter the AB native tag name directly in the text box of [Device] in the setting dialog.
At the beginning of the tag name, add a "::" symbol indicating the tag.
When specifying a tag which has not been imported with bit position, available bit positions are b0 to b15.

When you enter the tag name directly, the data type consistency check between the AB native tag and the object device 
or others is not performed automatically.
Therefore, the data types may be inconsistent between the AB native tag and the object device or others.

(2) Using the input assist
Search and set AB native tags in the setting dialog of objects or others.
For how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)
When using the input assist, you have to import the AB native tags in advance.
Import the AB native tags before setting them.

➟■2 Importing a tag file

(3) Selecting a tag from the tag list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button for [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog that appears varies with the 
selection of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.
11.10.4 Customizing the settings related to editing operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Directly entering the tag name

Bit position

@2 : 1-5  : : StopFlg1 . b1

Tag name
Symbol (::) indicating the tag
PLC station No.
NW No.
Channel No.
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Step 2 In the [Select CH No.] dialog, click the [AB Native Tag] button to display the [Select AB Native Tag] dialog.

➟■6 [Select AB Native Tag] dialog
Step 3 Select an AB native tag from the tag list, and click the [OK] button to set the tag for [Device].

■4 Precautions for AB native tags

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.

(1) Precautions for importing a tag file
(a) Tag files to be imported

For importing AB native tags, use L5K, L5X, or CSV files outputted from RSLogix 5000.
If you edit an outputted file, the tag may not be imported to GT Designer3 properly.

(b) Tag files when using structure-type AB native tags
When using structure-type AB native tags, import L5K or L5X tag files.

(c) Tag files when using alias tags that refer to structure-type tags
When using alias tags that refer to structure-type tags, import L5K or L5X tag files.

(d) Hierarchy layers of importable tags
When you import an L5K or L5X tag file, the supported number of hierarchy layers is up to 15.
Tags with 16 or more hierarchy layers are not imported.

(2) Unusable AB native tags
The string-type AB native tags of a structure are unusable on the GOT.

(3) AB native tag name
When you use multiple AB native tags whose names are long, the monitoring process may take a longer time.

(4) Directly entering an AB native tag name
When the data type of an AB native tag is string, import the tag and then set the tag by entering its name.
If you do not import the tag before setting it, the data type cannot be recognized as string, and a system alarm occurs.

(5) Device setting for the channel whose [Controller Type] is [AB Control/CompactLogix(Tag)]
For the channel whose [Controller Type] is [AB Control/CompactLogix(Tag)] in the controller setting, only AB native tags 
and GOT internal devices are usable in the device setting.
To use controller devices in the device setting, do not select [AB Control/CompactLogix(Tag)] for [Controller Type].

(6) Station No. switching while AB native tags are being used
The station No. switching is not available to the station using AB native tags.
Do not use AB native tags for the station requiring the station No. switching.

(7) Number of characters when a string-type AB native tag is used
Set an even number of characters to be stored.
If you set an odd number of characters, some characters may not be monitored.

The set device, label, or tag is displayed.

Click this button to set an AB native tag.
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(8) Data type of a structure
When a CSV file is imported, the data type of a structure varies depending on the data type name of the structure.
• When the data type name contains the word "STRING"
String-type structure

• When the data type name does not contain the word "STRING"
Non-string type structure.

(9) Offset setting for AB native tags
The offset setting is not available to AB native tags.
Do not configure the offset setting for AB native tags.

➟6.1.11 Offset

(10)Writing package data
When you set AB native tags in a project and write the project data to the GOT, [Write Mode] is not selectable in the [Write 
Option] dialog.
In this case, [Write Mode] is fixed to [Synchronize].

➟4.8.3 [Write Option] dialog (for writing data to one GOT)

(11)Number of characters of the comment set for an AB native tag
Set the comment in 1024 characters or less for an AB native tag.
The 1025th and subsequent characters are not displayed on GT Designer3.

(12)Bit specification of a double-word device of an AB native tag
If you use the latest GT Designer3 to open a project to which AB native tags have been imported using GT Designer3 
Version1.275M or earlier, bit specification (b0 to b31) is not available for the tags of the following data types.
• [DINT]
• [REAL]
• [UDINT]
The AB tag information needs to be updated in the latest GT Designer3.
Display the [AB Native Tag List] dialog.
The tag files that need updates are displayed in red text in the tag file list.
Click the [OK] button to update the files.

➟6.1.9 ■5 [AB Native Tag List] dialog

■5 [AB Native Tag List] dialog

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
Select [Project] → [Import Other Data] → [Tag] → [AB Native Tag] from the menu to display the setting dialog.

1) [Add] button
Displays the [Add Tag Data] dialog.
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Import an AB native tag file.

2) [Edit] button
Displays the [Edit Tag Data] dialog.
Edit the settings of the selected tag file.

3) [Delete] button
Deletes a selected tag file.

4) [Delete All] button
Deletes all tag files.

5) Tag file list
Lists the imported tag files of AB native tags and the connected channels.

■6 [Select AB Native Tag] dialog

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
Select an AB native tag from the tag list to set the tag in the device setting of an object or others.
To display this dialog, click the [AB Native Tag] button in the [Select CH No.] dialog.

1) [AB Native Tag Setting]
Select a combination of the channel number, network setting, and remarks of the imported AB native tags.

2) [Refinement]
Enter characters to narrow down the AB native tags in the tag list.
Only the AB native tags narrowed down by the entered characters are displayed in the tag list.
Up to 32 characters can be entered.

• [CH No.]
Select the CH No. for connection to the PLC that uses AB native 
tags.

• [Network Setting]
Specify the network for the PLC that uses AB native tags.

• [File Path]
Set the path to the tag file to be imported.

• [Tag Data Name]
Set the tag data name displayed on GT Designer3.

• [CH No.]
Select the CH No. for connection to the PLC that uses AB native 
tags.

• [Network Setting]
Specify the network for the PLC that uses AB native tags.

• [File Path]
Set the path to the tag file to be imported.

• [Tag Data Name]
Displays the tag data name displayed on GT Designer3.
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The entered characters are case-insensitive.
3) Search

Search the AB native tag list for a tag by the specified keyword.
Set [Search Target] and enter a search keyword in [Keyword].
Click the [Find Next] button to search for the next occurrence of the keyword.

The following shows the items selectable for [Search Target].
• [All]
• [Tag Name]
• [Base Tag Name]
• [Data Type]
• [Comment]

Up to 32 characters can be entered in [Keyword].
The entered characters are case-insensitive.

4) AB native tag list
AB native tags are listed.
Select an AB native tag from the tag list and click the [OK] button to set the tag in [Device].

5) [Bit Position]
Set the bit position of an AB native tag.
The setting range depends on the data type.
• Word type: [0] to [15]
• Double-word: [0] to [31]
If the [Select AB Native Tag] dialog has been brought up from the [Device List] dialog, [Bit Position] is not settable.

Item Description

[No.] Number of an AB native tag

[Tag Name] Name of an AB native tag

[Base Tag Name] Base tag name of an AB native tag

[Data Type] Data type of an AB native tag

[Comment] Comment set for an AB native tag
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6.1.10 How to set OPC UA tags

➟■1 Usable OPC UA tags
■2 Importing a tag information file
■3 Setting an OPC UA tag
■4 Precautions for OPC UA tags
■5 [OPC UA Tag List] dialog
■6 [Select OPC UA Tag] dialog

You can specify the OPC UA tags of an OPC UA server in device settings in GT Designer3.
To do this, import the tag information of the OPC UA server to GT Designer3.
The following shows the steps taken to specify an OPC UA tag as a device in GT Designer3.

Step 1 With GT OPC UA Client, obtain tag information from an OPC UA server and export the obtained data to a 
tag information file.

➟MELSOFT GT OPC UA Client Operating Manual
Step 2 Import the tag information file to GT Designer3.

➟■2 Importing a tag information file
Step 3 Specify an OPC UA tag as a device in GT Designer3.

➟■3 Setting an OPC UA tag

GT SoftGOT2000 monitors the OPC UA tags of an OPC UA server by using a project in which the tags are set.
For the OPC UA client connection, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual
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Personal computer

GT Designer3GT OPC UA Client

OPC UA server

Obtain

Tag information file

Export Import

Address Space

Dev00

Group000

Str000

Dev01

OPC UA tag
・Tag000

・Tag001

・Tag002

Tag information

1. 2.
3.

1. Device setting

OPC UA server

GT SoftGOT2000

Ethernet

Tag000 50
Tag001 300

OPC UA tag

Tag name Current value

Tag000 50

Tag001 300
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■1 Usable OPC UA tags

The following shows the specifications of tag information files that can be imported and the specifications of usable OPC 
UA tags.

(1) Importable tag information files

(2) Characters in the tag names of OPC UA tags
OPC UA tags with the following characters in their names will not be imported.

• " & ( ) . ; { }
• // (Double slash)
• U+0000 to U+001F (C0 control code)
• U+007F (Delete character)
• U+0080 to U+009F (C1 control code)
• One-byte space at the start or end of a tag name
• Two-byte space at the start or end of a tag name

An OPC UA server, GT Designer3, and GT SoftGOT2000 use different encoding formats for tag names.
For precautions for encoding formats, refer to the following.

➟6.1.10 ■4 (6) Encoding formats used
Case sensitivity differs between an OPC UA server and GT Designer3.
For precautions for case sensitivity, refer to the following.

➟6.1.10 ■4 (7) Case sensitivity of tag names

(3) Display of OPC UA tags in GT Designer3
The imported tag information and OPC UA tags are displayed in GT Designer3 as shown below.

In GT Designer3, a tag name includes the names of parent folders (groups and structures) of the tag.
The tag name does not include the folder names "Views", "Objects", and "Types".
The folder names within a tag name are separated by a period (.).
If a tag name includes 326 or more characters (excluding the ampersand), the tag will not be imported.
For arrays, if a tag name includes 347 or more characters including element numbers (excluding the ampersand), the tag 
will not be imported.

➟6.1.10 ■1 (6) Array

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications

File format Tag information file (*.gtuc)

Maximum number of tag information files
One tag information file is imported for each channel.
A tag information file is imported for a channel for which [Controller Type] is set to [OPC UA] 
in the [Controller Setting] window.

Maximum number of OPC UA tags 20480 in one tag information file

&Address Space.Dev00.Group000.Tag000

Ampersand representing an OPC UA tag
Tag name

Views

Tag information

Objects

Dev00

Group000

Str000

Str001

Dev01

・Tag000

・Tag001

・Tag002

Address Space

Types
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(4) Supported data types of OPC UA tags
The following shows the data types of OPC UA tags supported by GT Designer3.
In GT Designer3, select the data types or device types that correspond to the data types of OPC UA tags.
Only the following types of OPC UA tags will be imported to GT Designer3.

*1 An OPC UA server, GT Designer3, and GT SoftGOT2000 use different encoding formats for string data.
For precautions for encoding formats, refer to the following.
➟6.1.10 ■4 (6) Encoding formats used

For settings requiring consecutive devices or devices that store string data, use the following types of OPC UA tags.

Supported data type of OPC UA tags Data type or device type selectable in GT 
Designer3 Remarks

Boolean Bit The word specification of bit devices is not 
available.

Int16

Signed 16-bit binary
The bit specification of word devices is not 
available.Unsigned 16-bit binary

BCD16

UInt16

Signed 16-bit binary
The bit specification of word devices is not 
available.Unsigned 16-bit binary

BCD16

Int32

Signed 32-bit binary

The bit specification of word devices is not 
available.

Unsigned 32-bit binary

BCD32

Real number

UInt32

Signed 32-bit binary

The bit specification of word devices is not 
available.

Unsigned 32-bit binary

BCD32

Real number

Float

Signed 32-bit binary

The bit specification of word devices is not 
available.

Unsigned 32-bit binary

BCD32

Real number

String*1 Character string The bit specification of word devices is not 
available.

Item Settable OPC UA tag

Consecutive devices

Use array-type OPC UA tags.
Make sure that as many array elements as the required number of consecutive devices are 
set on an OPC UA server.
For precautions for writing data to arrays, refer to the following.

➟6.1.10 ■4 (5) Writing data to arrays

Devices that store string data
Use string-type OPC UA tags.
Make sure that a data length equivalent to the required number of devices is set for the OPC 
UA tags on an OPC UA server.
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(5) Structure
You can specify the members of a structure in device settings.
The supported data types of members are the same as the supported data types of usable OPC UA tags.

➟6.1.10 ■1 (4) Supported data types of OPC UA tags
A member of a structure is displayed in GT Designer3 as shown below.
Example) Display of member VAR00 of structure Str000

The structure name and member name within a tag name are separated by a period (.).

(6) Array
Arrays must satisfy the following requirements.

An array is displayed in GT Designer3 as shown below.
Example) Display of array Tag [1]

Regardless of the start element number of an array set on an OPC UA server, GT Designer3 assumes the start element 
number to be zero.
For precautions for element numbers, refer to the following.

➟6.1.10 ■4 (4) Start element number of arrays

Views

Tag information

Objects

Dev00

Str000

Str001

Str002

Dev01

Address Space

Types

・VAR00

・VAR01

・VAR02

&Address Space.Dev00.Str000.VAR00

Structure name and member name

Member of 
a structure

Item Specifications

Number of dimensions

3 or less

Maximum number of elements 65536 regardless of the number of dimensions

Data type
Supported data types other than string

➟6.1.10 ■1 (4) Supported data types of OPC UA tags

Tag[0..3,0..5,0..10]

First dimension
Second dimension

Third dimension

&Address Space.Dev00.Group000.Tag[1]

Array name

Views

Tag information

Objects

Dev00

Group000

Str000

Str001

Dev01

・Tag[0]

・Tag[1]

・Tag[2]

・Tag[3]

・Tag[4]

Address Space

Types

Array

Element number
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(7) Offset setting for OPC UA tags
The offset setting is applied to array element numbers.
Example) Offset setting for an three-dimensional array
For Tag[0..4,0..4,0..4] set on an OPC UA server

• First dimension: The start element number is 0, and the number of elements is 5.
• Second dimension: The start element number is 0, and the number of elements is 5.
• Third dimension: The start element number is 0, and the number of elements is 5.

For an array of structures, the offset setting is not applied to the element numbers.
For an array of members of a structure, the offset setting is applied to the element numbers.
Example) Offset setting for a structure

■2 Importing a tag information file

Export a tag information file from GT OPC UA Client, and import the file to GT Designer3.
For information on how to install and operate GT OPC UA Client, refer to the following.

➟MELSOFT GT OPC UA Client Operating Manual
The following shows how to import a tag information file to GT Designer3.

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 For the channel for connecting to an OPC UA server, select [OPC] for [Manufacturer].

➟5.5.1 Setting channels
Step 3 Select [Project] → [Import Other Data] → [Tag] → [OPC UA Tag] from the menu to display the [OPC UA Tag 

List] dialog.
Step 4 Import a tag information file.

➟6.1.10 ■5 [OPC UA Tag List] dialog

OPC UA tag set for an object or others Offset device value Offset result

Tag[0,1,1]

2 Tag[0,1,3]

-1 Tag[0,1,0]

5 Tag[0,2,1]

119 A system alarm occurs due to invalid array subscripts.

OPC UA tag set for an object or others Applicability of the offset setting

Str[1].VAR01 The offset setting is not applied to an array of structures.

Str.VAR01[1] The offset setting is applied to an array of members of a structure.
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■3 Setting an OPC UA tag

Specify an OPC UA tag as a device by one of the following methods.
➟(1) Selecting an OPC UA tag from the tag list

(2) Setting an OPC UA tag with the input assist
(3) Directly entering a tag name

(1) Selecting an OPC UA tag from the tag list
Step 1 In the setting dialog of an object or others, hold down the [Shift] key and click the [...] button for [Device] to 

display the [Select CH No.] dialog.
If you click the [...] button without holding down the [Shift] key, the dialog that appears varies with the 
selection of [CH No. Selection Dialog Display Setting] on the [Edit] tab of the [Options] dialog.

➟11.10.4 Customizing the settings related to editing operations

Step 2 In the [Select CH No.] dialog, click the [OPC UA Tag] button to display the [Select OPC UA Tag] dialog.

➟6.1.10 ■6 [Select OPC UA Tag] dialog
Step 3 Select an OPC UA tag from the tag list, and click the [OK] button to set the tag for [Device].

(2) Setting an OPC UA tag with the input assist
Search for an OPC UA tag to set the tag in the setting dialog of an object or others.
For information on how to use the input assist, refer to the following.

➟11.3 Setting Devices from Device Comments (Input Assist)

(3) Directly entering a tag name
Enter an OPC UA tag name directly in the textbox of [Device] in the setting dialog of an object or others.
Prepend one ampersand (&), which represents an OPC UA tag, to the tag name.

For information on how tag names are displayed in GT Designer3, refer to the following.
➟6.1.10 ■1 (3) Display of OPC UA tags in GT Designer3

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The set device, label, or tag is displayed.

Click this button to specify an OPC UA tag.

@2 &Address Space.Dev00.Group000.Tag[0,1,1]

Ampersand representing an OPC UA tag
Tag name

Channel No.

Element numbers (for arrays only)
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■4 Precautions for OPC UA tags

(1) Changing channel settings
If you change the settings of the channel for connecting to an OPC UA server in the [Controller Setting] window, the tag 
information for the channel will be deleted.

(2) Importing a tag information file if an OPC UA tag is set
After you specify an OPC UA tag as a device, if you import a same-name OPC UA tag of a different data type, the 
specified tag may be displayed as [??].
If [??] is displayed, specify the relevant OPC UA tag again.

(3) Checking the data types of OPC UA tags
If you change the data type of an object or others, the data types may be inconsistent between the specified OPC UA tag 
and the object or others.
Check that the data types are consistent between the tag and the object or others.
To check the data type consistency, you are recommended to compare the tag information in GT OPC UA Client and the 
file exported from [Device List] of GT Designer3.

(4) Start element number of arrays
Regardless of the start element number of an array set on an OPC UA server, GT Designer3 assumes the start element 
number to be zero.
However, GT SoftGOT2000 monitors the array elements as they are set on the OPC UA server.

Example) Monitoring a one-dimensional array with 5 elements, starting with element number 10
To monitor Tag[12] of the OPC UA server, specify Tag[2] as a device in GT Designer3.

(5) Writing data to arrays
Data is written to the arrays set as consecutive devices only when all the following conditions are satisfied.

• Array element number 0 is set for the start device of consecutive devices.
• The number of array elements set on an OPC UA server equals to the number of consecutive devices set in GT 

Designer3.

(6) Encoding formats used
An OPC UA server, GT Designer3, and GT SoftGOT2000 use different encoding formats.

• OPC UA server: UTF-8
• GT Designer3 and GT SoftGOT2000: UTF-16

Therefore, GT Designer3 and GT SoftGOT2000 change the encoding format of tag names and string data.
The following shows how the data is converted in the software applications.
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OPC UA server

Dev00

Tag[10..14]

Tag[10]

Tag[11]

Tag[12]

Tag[13]

Tag[14]

Address Space

GT Designer3

Dev00

Tag[0..4]

Tag[0]

Tag[1]

Tag[2]

Tag[3]

Tag[4]

Address Space

If you specify Tag[2] as a device in GT Designer3, 
the GOT monitors Tag[12] of the target OPC UA server.

Software Tag name String data

GT Designer3

Changes the encoding format to UTF-16 when 
importing a tag information file.
Does not import OPC UA tags with invalid 
characters in their names.

-

GT SoftGOT2000

Changes the encoding format when accessing an 
OPC UA tag. (between UTF-8 and UTF-16)
If invalid characters are included, a system alarm 
occurs.

Changes the encoding format when accessing an 
OPC UA tag. (between UTF-8 and UTF-16)
Converts invalid characters to one-byte spaces 
(0x20).
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(7) Case sensitivity of tag names
Tag names are case-insensitive in GT Designer3.
If tag names are case-sensitive on an OPC UA server, tag names may be duplicated when OPC UA tags are imported 
to GT Designer3.
Duplicate tags will not be imported.

(8) Data storage order settings when string-type OPC UA tags are set
Configure the following settings for functions that use string-type OPC UA tags.

• Text display object, text input object
Select [Display in order of High -> Low] in the [Extended] tab.

• Text print object
Select [Display in order of High -> Low].

• Recipe function, logging function
Select [Low-->High] for [Storage Order] in the [Device] tab.

■5 [OPC UA Tag List] dialog

Select [Project] → [Import Other Data] → [Tag] → [OPC UA Tag] from the menu to display the setting dialog.

1) Tag information file list
Lists the channels for connecting to OPC UA servers and the imported tag information files.

2) [Add] button
Displays the [Add Tag] dialog.
Import a tag information file.

• [CH No.]
Select a channel for connecting to an OPC UA server.

• [Connection End Server Name]
Displays the name of the OPC UA server to be connected 
when a tag information file is selected.

• [Tag]
Displays the path to the selected tag information file.

• [Browse] button
Displays the [Browse] dialog.
Select a tag information file to be imported.

• [Get] button
Starts GT OPC UA Client.
Obtain tag information from an OPC UA server in GT OPC 
UA Client.

➟MELSOFT GT OPC UA Client Operating Manual
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3) [Edit] button
Displays the [Edit Tag] dialog.
Change the tag information file.

4) [Delete] button
Deletes the selected tag information file.

5) [Delete All] button
Deletes all tag information files.

• [CH No.]
Select a channel for connecting to an OPC UA server.

• [Connection End Server Name]
Displays the name of the OPC UA server to be connected.

• [Tag]
Displays the path to the selected tag information file.

• [Browse] button
Displays the [Browse] dialog.
Select a tag information file to be imported.

• [Get] button
Starts GT OPC UA Client.
Obtain tag information from an OPC UA server in GT OPC 
UA Client.

➟MELSOFT GT OPC UA Client Operating Manual
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■6 [Select OPC UA Tag] dialog

To display this dialog, click the [OPC UA Tag] button in the [Select CH No.] dialog.

1) [CH No.]
Select a channel for connecting to an OPC UA server.

2) [Connection End Server Name]
Displays the name of the OPC UA server corresponding to the channel selected for [CH No.].

3) Tag information tree
Displays the tag information corresponding to the channel selected for [CH No.].

4) [Refinement]
Enter a string to display tags with names containing the entered string in the OPC UA tag list.
Tags are narrowed down as a string is entered.
[Tag Name], [Data Type], [Comment], and [Access Direction] are searched.
Up to 64 characters can be entered.
The entered characters are case-insensitive.

5) [Search Target]
Enter a keyword and click the [Find Next] button to search for the OPC UA tags containing the keyword.
You can perform a search in the list after tags are narrowed down with [Refinement].
Up to 64 characters can be entered.
The entered characters are case-insensitive.

6) OPC UA tag list
OPC UA tags in the folder (group or structure) selected in the tag information tree.
Select an OPC UA tag and click the [OK] button to set the tag as a device.
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6.1.11 Offset

➟■1 Offset setting
■2 Application examples
■3 Precautions for the offset setting

Multiple target devices for monitoring can be switched according to a single device setting.
(In the simple alarm display, multiple target comments for displaying can be switched according to a single device.)
Example) Monitoring the status of multiple devices by switching them with a single device
The value set in the device using the offset is added to the devices set for each object.
The device set by the offset is hereinafter referred to as offset device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Devices set for each object

Offset device
D200, D201, D202

D100

Offset device 
value

Monitored devices are switched according to 
the value stored in the offset device.

Monitored device

D200
D201
D202

D210
D211
D212

D211
D212
D213

0

10

11
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■1 Offset setting

(1) Objects and functions for which the offset setting is available
The offset setting is available for the following objects and functions.
For how to set, refer to the following.

*1 For the switch, the offset device value is added to the device number of the device specified for the target action in [Action 
List].
However, the offset device value is not added to the device number of the device specified for any action of [SP function].

*2 For the following touch switches, the offset setting is available for the lamp function as well.
• Switch
• Bit switch
• Word switch
• Go To Screen switch
• Change Station No. switch
• Key window display switch

*3 The offset device value is added to the device number set in [Device] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Object, function Reference

Touch switch*1*2 ➟8.2 Placing a Touch Switch

Lamp (bit, word)*3 ➟8.3 Placing a Lamp

Numerical Display
➟8.4 Placing a Numerical Display and Numerical Input

Numerical Input

Text Display
➟8.5 Placing a Text Display and Text Input

Text Input

Comment Display ➟8.7 Placing a Comment Display

Parts display (bit, word) ➟8.8 Placing a Parts Display

Parts movement (bit, word) ➟8.9 Placing a Parts Movement

Simple Alarm Display ➟8.12 Placing a Simple Alarm Display

Level ➟8.23 Placing a Level Object

Panelmeter ➟8.24 Placing a Panelmeter

Line Graph ➟8.15 Placing a Line Graph

Trend Graph ➟8.16 Placing a Trend Graph

Bar Graph ➟8.17 Placing a Bar Graph

Statistics Bar Graph ➟8.18 Placing a Statistics Bar Graph

Statistics Pie Graph ➟8.19 Placing a Statistics Pie Graph

Scatter Graph ➟8.20 Placing a Scatter Graph

Slider ➟8.25 Placing a Slider

Script ➟9.8 Controlling Operations with Scripts ([Script])

Trigger Action ➟9.5 Operating a Device as a Trigger ([Trigger Action])
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(2) Device settings
If a bit of a word device is specified, the device No. is offset.
Example)

■2 Application examples

(1) Switching and monitoring multiple line statuses with a single numerical display
➟8.4 Placing a Numerical Display and Numerical Input

(2) Displaying multiple comments by switching them with a single device
The offset device value is added to the comment No. of comments set for a simple alarm display.
To display multiple comments using a simple alarm display in the usual way, you have to set the same number of bit 
devices with that of comments to be displayed. If the offset is used, multiple comments can be displayed by switching 
them with a single device.

➟9.1.5 Viewing alarm events (Alarm display)

(a) Offsetting display settings
The offset device value is added to the No. associated with the comment to be displayed.

Devices set for each object

Offset device

D200.b2

D100

The device No. is offset.

Offset 
device value

Monitored 
device

0

10

11

D200.b2

D210.b2

D211.b2

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

"Target number" monitors D201. 
(D200 + 1 = D201)
"Actual number" monitors D211. 
(D210 + 1 = D211)

"Target number" monitors D203. 
(D200 + 3 = D203)
"Actual number" monitors D213. 
(D210 + 3 = D213)

Write 3 to the 
offset device 
(D100) with a 
numerical input.

Line

Actual number

Target number
D100

D210
D100

D200
D100

Offset device

Offset device

Device

Device

Device
: Numerical input

: Numerical display 

: Numerical display

Line
Target 
number
Actual 
number

1

500
326

Line
Target 
number
Actual 
number

3

650
442

D100

D201
D202
D203

D211
D212
D213

3

500
800
650

326
277
442

Comment 1 is displayed when an alarm occurs. 
(First comment No.1 + 0 = 1)

Comment 2 is displayed when an alarm occurs. 
(First comment No.1 + 1 = 2)

First comment No.
Comment No. offset device

: 1
: D200

Alarm

Line A has stopped. The offset device 
value changes to 1.

Alarm

Line B has stopped.

D200 0 D200 1
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(b) Offsetting detail display settings
The offset device value is added to the No. of the comment (comment window), window screen, and base screen to be 
displayed as detail displays.

■3 Precautions for the offset setting

(1) Precautions for drawing
(a) Monitoring a trigger device for a trigger action periodically

Offset with a cycle longer than that of monitoring.
Example) Sampling cycle (7 s) of the offset device value > Sampling cycle of trigger action (5 s)

(b) Operation is not performed normally with the sampling cycle setting for the trigger action
If an object for which the offset has been specified is placed on the monitor screen, monitoring the trigger device for a 
trigger action becomes slow.
If a trigger action has been used, do not place objects for which the offset has been specified on the monitor screen.

(2) Precautions for use
(a) Changing the offset value

Monitor devices are read every time the offset value changes.
Frequent changes of the offset value may cause slower monitor speeds.

(b) When the device No. goes out of the range by executing the offset
When the device No. goes out of the range by executing the offset, monitoring and writing are not performed.
The error can be displayed if a simple alarm display is set.
If multiple devices are monitored in a single graph display, the display depends on the setting of the devices being 
monitored.
Trend graph, line graph, bar graph, and statistics graph

• If the devices are set contiguously: The previous display is held.
• If the devices are set randomly:

The previous display is held only when the device No. goes out of the range. Otherwise the display reflects the offset 
devices in monitoring.

Scatter graph
• If the devices are set contiguously: The previous display is held.
• If the devices are set randomly: The previous display is held.

(c) When an offset device is set outside the device range
Even if you set an offset device outside the device range, no system alarm occurs.
Make sure to set the offset device within the device range.

"Detail display" displays comment 1. 
(First comment No.1 + 0 = 1)

"Detail display" displays comment 2. 
(First comment No.1 + 1 = 2)

First comment No.
Comment No. offset device

: 1
Detail display : Comment window

: D200

Alarm

Line A has stopped.
The offset device 

value changes to 1.

D200 0 D200 1

Check the 
power supply.

Detail
display

Alarm

Line A has stopped.

Check if 
workpieces 
are present.

Detail
display

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.2 Setting Trigger Types

The following conditions can be set to each object for monitoring or writing.

■1 Display condition
Set to an object that monitors a device.
If the condition is not satisfied, monitoring the device is stopped or the display of the object is deleted.
Example)
Displaying only the numerical display function which is used for monitoring lines in production
Production Start signal (Line1: M11, Line 2: M12, Line3: M13)

■2 Operating condition
Set to an object that writes to a device.
If the condition is not satisfied, operation is prohibited or the display of the object is retained.
Example)
Setting a device for interlock to a touch switch
Line Operation Ready signal: M10

■3 Background function condition
Set to functions including the script and logging.
If the set condition is not satisfied, operation and saving data are not executed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

M11: OFF, M12: OFF, M13: OFF

The production quantities of 
suspended lines are not displayed.

The production quantities of 
lines in operation are displayed.

M11: ON, M12: OFF, M13: OFF

Product qty
Line 1

Line 2

Line 3

Product qty
Line 1

20

50

Line 2

Line 3

M10: OFF

The line is stopped.

RUN STOP

Line 1 ctrl screen

Product qty
Status STOP

0

M10: OFF

The line does not start to work even 
though the RUN switch is touched.

RUN STOP

Product qty
Status In preparation

0

Line 1 ctrl screen

M10: ON

After completion of the preparation, 
the line starts to work by touching 
the RUN switch.

RUN STOP

Product qty
Status RUN

0

Line 1 ctrl screen
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6.2.1 Specifications of the trigger type

➟■1 Trigger types
■2 Correspondence between functions and trigger types

■1 Trigger types

The following shows trigger types available for the display condition, operating condition, and background function 
condition.

(1) Available trigger type
For the trigger types available for each object and function, refer to the following.

➟■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Trigger type Execution condition Operation

Ordinary None The device is monitored at the monitoring cycle of the GOT.

ON
The condition is satisfied while the trigger device is on or off.
• When set to an object (display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set to an object (operating condition)

While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(b) Operation performed when the operating condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.

OFF

Rise The condition is satisfied when the trigger device is on or off.
• When set to an object (display condition)

When the condition is satisfied, the device is monitored only once.
While the condition is not satisfied, the display of the object is retained.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.

Fall

Rise/Fall

Sampling

The condition is satisfied at each set cycle.
• When set to an object (display condition)

When the condition is satisfied, the device is monitored only once.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.

ON

OFF

ON

OFF

OFF

ON

OFF

ON

ON ON

OFF OFF

Cycle
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Range

Word device value
Example)
Trigger device: D100
Range: 0 < D100 < 100
Condition is satisfied: D100 = 100
Condition is not satisfied: D100 = -100

When the trigger device value is within the set range, the condition is satisfied.
• When set to an object (display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is retained.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set to an object (operating condition)

While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(b) Operation performed when the operating condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.

Bit Trigger Logical operation result of the on/off 
status of the specified bit devices

When the set AND or OR condition matches with the status of the specified 
devices, the condition is satisfied.
• When set to an object (display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set to an object (operating condition)

While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(b) Operation performed when the operating condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.

ON Sampling
The condition is satisfied while the trigger device is on or off.
• When set to an object (display condition)

While the condition is satisfied, the device is monitored at the set cycle.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed by 
changing the setting.
➟(a) Operation performed when the display condition is not satisfied
• When set as the background function condition

Operation and saving data are executed.
OFF Sampling

View Change When the display of the object is 
changed

The condition is satisfied when the display of the object is changed.
• When set as the background function condition

Operation and saving data are executed.

Synchronize Display 
Trigger

The same condition as the display 
condition set to the object

The condition is satisfied when the object for which the trigger type is set is 
displayed.
• When set as the background function condition

Operation and saving data are executed.

Key Code Input

When the following key codes are 
input
• 0008h (Delete the least significant 

digit and right-shift all digits for one 
digit)

• 0088h (Delete the content being 
input)

• 002Dh (Alternate the sign)
• 002Eh (.)
• ASCII code, shift JIS code, Kanji 

code

The condition is satisfied when the key codes shown on the left are input.
• When set as the background function condition

Operation and saving data are executed.

Input Fixation
When the input data is written into the 
device by the key code 000Dh 
(Execute)

The condition is satisfied when the key code which determines the input 
content.
• When set as the background function condition

Operation and saving data are executed.

Trigger type Execution condition Operation

ON

OFF

Cycle

ON

OFF

Cycle
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*1 For the setting procedure, refer to the following.

➟9.6 Operating the Set Time as a Trigger ([Time Action])

(a) Operation performed when the display condition is not satisfied
Operation performed when the condition is not satisfied can be changed by changing the setting in the setting dialog.
For the setting items for each trigger type, refer to the following.

➟6.2.2 ■1 Setting display conditions and operating conditions
• Displaying an object when the screen is switched for the first time

When [Display objects immediately after the screen is switched regardless of display conditions] is selected and if 
the screen is switched for the first time, the device is monitored and displayed even though the display condition is 
not satisfied.

• Retaining the display of the object
When [Retain the object display when display conditions are not satisfied] is selected, the display of the object is 
retained when the condition which has been satisfied goes to be not satisfied.

(b) Operation performed when the operating condition is not satisfied
When [Clear the input object] of the [Environmental Setting] window or the [Screen Property] dialog is selected, the 
display of the object is deleted when the condition is not satisfied.
For how to configure the setting in the [Environmental Setting] window or the [Screen Property] dialog, refer to the 
following.

➟2.7 Changing Screen Property
5.2.4 Setting key windows ([Key Window])

(c) Object with a shape
When the trigger type is [ON], [OFF], or [Bit Trigger] and a shape frame is set to the object
If the object is deleted, only the shape frame is left and displayed.

Device Writing When bit set or word set is executed 
by a touch switch

The condition is satisfied when the touch switch with the bit set or word set is 
executed.
• When set as the background function condition

Operation and saving data are executed.

When closing a screen When the screen is switched to 
another screen or closed

The condition is satisfied when the screen is switched to another screen or 
closed.
• When set as the background function condition

Operation and saving data are executed.

Time*1 The day and time which are set
The condition is satisfied when the day and time set to the GOT comes.
• When set as the background function condition

Operation and saving data are executed.

Trigger type Execution condition Operation

Object
Shape frame

When the condition 
is satisfied

When the condition 
is not satisfied

The shape frame remains displayed.

1500
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(2) Operation of multiple bit conditions
As the display condition, operating condition, or background function condition, two to eight bit devices and their on/off 
status can be set.
Logical AND or logical OR is executed to the on/off status of the bit devices for the set number.
Example) When M10, M11, and M12 are used as the display conditions
○: Condition is satisfied
×: Condition is not satisfied

Display condition M10 is ON M11 is OFF M12 is ON
Operation result

Logical AND Logical OR

ON, OFF
(Satisfied/Not satisfied)

OFF
(×)

OFF
(○)

OFF
(×) × ○

ON
(○)

OFF
(○)

OFF
(×) × ○

OFF
(×)

ON
(×)

OFF
(×) × ×

ON
(○)

ON
(×)

OFF
(×) × ○

OFF
(×)

OFF
(○)

ON
(○) × ○

ON
(○)

OFF
(○)

ON
(○) ○ ○

OFF
(×)

ON
(×)

ON
(○) × ○

ON
(○)

ON
(×)

ON
(○) × ○
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■2 Correspondence between functions and trigger types

The following shows objects and functions for which the display condition, operating condition, and background function 
condition can be set.
Available trigger types differ depending on the type of an object or a function.

(1) Display condition

*1 If [Display Mode] is [Replace] and [Retain the object display when display conditions are not satisfied] is not selected, the 
object is deleted when the condition is not satisfied.

*2 If [Display Mode] is [Locus] and/or [Retain the object display when display conditions are not satisfied] is selected, the 
display of the object is retained when the condition is not satisfied.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function
Available trigger type

GT27, GT25, GT23, GT SoftGOT2000, GS25 GT21, GS21

Lamp

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• Range
• Bit Trigger
• ON Sampling
• OFF Sampling

• Ordinary
• ON
• OFF
• Range
• Bit Trigger

Numerical display

Text display

Comment display

Parts display (Bit part) *1

Parts display (Word part) *2

Parts movement

Line graph

Bar graph

Statistics bar graph

Statistics pie graph

Graphical meter -

Level object

• Ordinary
• ON
• OFF
• Range
• Bit Trigger

Panelmeter

Parts display (Fixed parts)

• ON
• OFF
• Range
• Bit Trigger

Alarm display • Ordinary
• ON
• OFF
• Range
• Bit Trigger

Simple alarm display

Trend graph

• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling

• Sampling

Scatter graph

• Ordinary
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling

• Ordinary
• Sampling
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(2) Operating condition

(3) Background function condition
(a) Time setting

(b) Backup/restore

*1 For the setting procedure, refer to the following.

➟9.6 Operating the Set Time as a Trigger ([Time Action])

(c) Script

Function Available trigger type

Touch switch
• Ordinary
• ON
• OFF
• Range
• Bit Trigger

Numerical input

Text Input

Slider

Operation panel keys (Operation Panel function)

Function Available trigger type

Time setting
• Rise
• Fall
• Sampling

Function Available trigger type

Backup/restore
• Rise

• Time*1

Script Available trigger type

Project script

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling

Screen script • Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling
• When closing a screen

Script parts
6. BASIS OF SETTING AND EDITING
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(d) Logging

Display object script

• Lamp
• Date display
• Time display
• Graphical meter
• Panelmeter

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling
• View Change

• Numerical display
• Numerical input

(When [Display] is selected in the [Operation/
Script] tab)

• Text display
• Text input

(When [Display] is selected in the [Script] tab)
• Comment display
• Parts display
• Parts movement
• Line graph
• Trend graph
• Bar graph
• Statistics bar graph
• Statistics pie graph
• Scatter graph
• Historical trend graph
• Level object

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling
• View Change
• Synchronize Display Trigger

Input object script

• Numerical input
(When [Input] is selected in the [Operation/
Script] tab)

• Text input
(When [Input] is selected in the [Script] tab)

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling
• Key Code Input
• Input Fixation

Switch object script • Touch switch

• Ordinary
• ON
• OFF
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling
• Device Writing

Function Available trigger type

Logging (When set in the [Basic] tab)

• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling

Logging (When set in the [File Save] tab)

• None
• Rise
• Fall
• Rise/Fall
• Sampling
• ON Sampling
• OFF Sampling

Script Available trigger type
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(e) Device data transfer

(f) Trigger action

Function Available trigger type

Device data transfer
• Rise
• Fall
• Sampling

Function Available trigger type

Trigger action

• Ordinary
• Rise
• Fall
• Rise/Fall
• ON
• OFF
• Sampling
• Range
• Bit Trigger
• ON Sampling
• OFF Sampling
6. BASIS OF SETTING AND EDITING
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6.2.2 Setting Trigger Types

➟■1 Setting display conditions and operating conditions
■2 Setting background function conditions

■1 Setting display conditions and operating conditions

The display condition and operating condition can be set in the [Trigger] tab of the setting dialog of each object.
Since different setting items are prepared for each display condition and operating condition, refer to each description for 
the setting item displayed on the setting dialog.

1) [Trigger Type]
Select a trigger to display or operate the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

For available triggers for each object, refer to the following.
➟■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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2) [Settings]
The setting items differ depending on the setting of [Trigger Type].
For the setting items for each trigger, refer to the following.

➟(1) When [Ordinary] is selected
(2) When [ON] or [OFF] is selected
(3) When [Rise], [Fall], or [Rise/Fall] is selected
(4) When [Sampling] is selected
(5) When [Range] is selected
(6) When [Bit Trigger] is selected
(7) When [ON Sampling] or [OFF Sampling] is selected

To set a device, refer to the following.
➟6.1 Device Settings

(1) When [Ordinary] is selected
No setting item is prepared.

(2) When [ON] or [OFF] is selected

1) [Trigger Device]
Set a trigger device.

2) [Display objects immediately after the screen is switched regardless of display conditions]
Not available to GT21 and GS21.
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

3) [Retain the object display when display conditions are not satisfied]
Not available to GT21 and GS21.
When this item is selected, the display of the object is retained when the condition which has been satisfied goes 
to be unsatisfied.

(3) When [Rise], [Fall], or [Rise/Fall] is selected

1) [Trigger Device]
Set a trigger device.

2) [Display objects immediately after the screen is switched regardless of display conditions]
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

(4) When [Sampling] is selected

1) [Sampling]
Set a cycle at which the device is monitored.
The setting range differs depending on the type of an object or a function.

• [1] second to [3600] seconds
• [1] x 100ms to [36000] x 100ms

2) [Display objects immediately after the screen is switched regardless of display conditions]
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

1)
2)
3)

1)
2)

1)
2)
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(5) When [Range] is selected

1) [Data Type]
Select the data type of the trigger device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [Real(32bit)]
• [Real(64bit)]

2) [Trigger Device]
Set a trigger device.

3) [Range]
Click the [Range] button to set the range of the trigger device.

➟6.5.5 ■2 (3) [Edit Range] dialog
4) [Display objects immediately after the screen is switched regardless of display conditions]

Not available to GT21 and GS21.
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

5) [Retain the object display when display conditions are not satisfied]
Not available to GT21 and GS21.
When this item is selected, the display of the object is retained when the condition which has been satisfied goes 
to be unsatisfied.

1)
2)
3)
4)
5)
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(6) When [Bit Trigger] is selected

1) [Number of Bits]
Set the number of conditions.
The setting range is [2] to [8].

2) [Trigger]
Select trigger conditions of multiple bits.
The following shows the items to be selected.

• [AND]: The condition is satisfied when all the set [ON/OFF] conditions match with the on/off status of the 
devices.

• [OR]: The condition is satisfied when one or more of the set [ON/OFF] conditions match with the on/off status 
of the devices.

3) [Device]
Select how to set the multiple devices.
The following shows the items to be selected.

• [Continuous]: Sets devices successively for the number set in [Number of Bits] starting from the device 
numbers specified for the set device.

• [Random]: Sets devices one by one for the number set in [Number of Bits].
4) [Device]

Select each row to set a trigger device.
The set devices are displayed on the list.

5) [ON/OFF]
Select the on/off status as the trigger condition for each device set in [Device].
The following shows the items to be selected.

• [ON]
• [OFF]

6) [Display objects immediately after the screen is switched regardless of display conditions]
Not available to GT21 and GS21.
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

7) [Retain the object display when display conditions are not satisfied]
Not available to GT21 and GS21.
When this item is selected, the display of the object is retained when the condition which has been satisfied goes 
to be unsatisfied.

 1)
 2)
 3)
 4) 5)

 6)
 7)
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(7) When [ON Sampling] or [OFF Sampling] is selected

1) [Trigger Device]
Set a trigger device.

2) [Sampling]
Set a cycle at which the device is monitored.
The setting range differs depending on the type of an object or a function.

• [1] second to [3600] seconds
• [1] x 100ms to [36000] x 100ms

3) [Display objects immediately after the screen is switched regardless of display conditions]
When this item is selected and if the screen is switched for the first time, the device is monitored and displayed even 
though the display condition is not satisfied.

4) [Retain the object display when display conditions are not satisfied]
When this item is selected, the display of the object is retained when the condition which has been satisfied goes 
to be unsatisfied.

1)
2)
3)
4)
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■2 Setting background function conditions

Set the background function condition in one of the following dialogs according to the function used.
• The setting dialog for each function
• [TriggerSetting] dialog

Example) When set in the [TriggerSetting] dialog
Click the [TriggerSetting] button in the setting dialog to display the [TriggerSetting] dialog.

1) [Trigger Type]
Select a trigger to display or operate the object.
The following shows the items to be selected.

• [None]
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]
• [View Change]
• [Synchronize Display Trigger]
• [Key Code Input]
• [Input Fixation]
• [Device Writing]
• [When closing a screen]

For available triggers for each object, refer to the following.
➟■2 Correspondence between functions and trigger types

2) [Settings]
The setting items differ depending on the setting of [Trigger Type].
For the setting items for each trigger, refer to the following.

➟(1) When [None], [Ordinary], [View Change], [Synchronize Display Trigger], [Key Code Input], [Input 
Fixation], [Device Writing], or [When closing a screen] is selected
(2) When [ON] or [OFF] is selected
(3) When [Rise], [Fall], or [Rise/Fall] is selected
(4) When [Sampling] is selected
(5) When [Range] is selected
(6) When [Bit Trigger] is selected
(7) When [ON Sampling] or [OFF Sampling] is selected

To set a device, refer to the following.
➟6.1 Device Settings

(1) When [None], [Ordinary], [View Change], [Synchronize Display Trigger], [Key Code Input], [Input 
Fixation], [Device Writing], or [When closing a screen] is selected
No setting item is prepared.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) When [ON] or [OFF] is selected

1) [Trigger Device]
Set a trigger device.

(3) When [Rise], [Fall], or [Rise/Fall] is selected

1) [Trigger Device]
Set a trigger device.

(4) When [Sampling] is selected

1) [Sampling]
Set a cycle at which the device is monitored.
The setting range differs depending on the type of an object or a function.

• [1] second to [3600] seconds
• [1] x 100ms to [36000] x 100ms
• [1] x 100ms to [600] x 100ms
• [1] minute to [1440] minutes

1)

1)

1)
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(5) When [Range] is selected

1) [Data Type]
Select the data type of the trigger device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [Real(32bit)]
• [Real(64bit)]

2) [Trigger Device]
Set a trigger device.

3) [Range]
Click the [Range] button to set the range of the trigger device.

➟6.5.5 ■2 (3) [Edit Range] dialog
4) [Operation Mode]

Select an operation mode of when the condition is satisfied.
• [Satisfied]: When the condition is satisfied, the operation is executed.
• [Satisfied (Sampling)]: While the condition is satisfied, the operation is executed at each set cycle.

(6) When [Bit Trigger] is selected

1) [Number of Bits]
Set the number of conditions.
The setting range is [2] to [8].

2) [Trigger]
Select trigger conditions of multiple bits.
The following shows the items to be selected.

• [AND]: The condition is satisfied when all the set [ON/OFF] conditions match with the on/off status of the 
devices.

• [OR]: The condition is satisfied when one or more of the set [ON/OFF] conditions match with the on/off status 
of the devices.

1)
2)
3)
4)

1)
2)

3)4)

5)
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3) [Device]
Select how to set the multiple devices.
The following shows the items to be selected.

• [Continuous]: Sets devices successively for the number set in [Number of Bits] starting from the device 
numbers specified for the set device.

• [Random]: Sets devices one by one for the number set in [Number of Bits].
4) [Device]

Select each row to set a trigger device.
The set devices are displayed on the list.

5) [ON/OFF]
Select the on/off status as the trigger condition for each device set in [Device].
The following shows the items to be selected.

• [ON]
• [OFF]

(7) When [ON Sampling] or [OFF Sampling] is selected

1) [Trigger Device]
Set a trigger device.

2) [Sampling]
Set a cycle at which the device is monitored.
The setting range differs depending on the type of an object or a function.

• [1] second to [3600] seconds
• [1] x 100ms to [36000] x 100ms
• [1] x 100ms to [600] x 100ms
• [1] minute to [1440] minutes

6.2.3 Precautions

■1 Trigger setting for a line graph
If the number of devices monitored by the line graph is large and [Trigger Type] is [Ordinary], processing the object may 
delay.
In that case, change [Trigger Type] to [Sampling] and set 2 or more seconds for the cycle.

1) 2)
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6.3 Date/Time Format Settings

When the date and time are displayed on the objects, the display format of the date and time can be selected.

■1 Date format
Set the display format of the date.
The display of the date can be changed according to language switching.

■2 Time format
Set the display format of the time.

6.3.1 Specifications of date/time formats

➟■1 Types of date/time formats
■2 Correspondence between functions and date/time formats

■1 Types of date/time formats

The following shows the types of date/time formats.

(1) Date format
Example) To display Wednesday, December 25, 2013

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Date format
Display contents

[Delimiter] is [/] [Delimiter] is [-] [Delimiter] is [.]

25/12/13 25-12-13 25.12.13 Date, month, year

25/Dec 25-Dec 25.Dec
Date, month

25/DEC 25-DEC 25.DEC

25/Dec(WED) 25-Dec(WED) 25.Dec(WED)
Date, month (day)

25/DEC(WED) 25-DEC(WED) 25.DEC(WED)

25/Dec/13 25-Dec-13 25.Dec.13
Date, month, year

25/DEC/13 25-DEC-13 25.DEC.13

25/Dec/13(WED) 25-Dec-13(WED) 25.Dec.13(WED)
Date, month, year (day)

25/DEC/13(WED) 25-DEC-13(WED) 25.DEC.13(WED)

25/Dec/2013 25-Dec-2013 25.Dec.2013
Date, month, year

25/DEC/2013 25-DEC-2013 25.DEC.2013

25/Dec/2013(WED) 25-Dec-2013(WED) 25.Dec.2013(WED)
Date, month, year (day)

25/DEC/2013(WED) 25-DEC-2013(WED) 25.DEC.2013(WED)

25/12/2013 25-12-2013 25.12.2013 Date, month, year

25/12/2013(WED) 25-12-2013(WED) 25.12.2013(WED) Date, month, year (day)

25/12 25-12 25.12 Date, month

25/12(WED) 25-12(WED) 25.12(WED) Date, month (day)

25/12/13(WED) 25-12-13(WED) 25.12.13(WED) Date, month, year (day)

Month, year

Month, year (day)

Year, month, date

Year, month, date (day)

Year, month, date

12月25日 12月25日 12月25日

12月25日(水) 12月25日(水) 12月25日(水)

13年12月25日 13年12月25日 13年12月25日

13年12月25日(水) 13年12月25日(水) 13年12月25日(水)

2013年12月25日 2013年12月25日 2013年12月25日
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(2) Time format
Example) To display 13:25:45

■2 Correspondence between functions and date/time formats

The following shows the objects for which the date/time formats can be set.

Year, month, date (day)

Month, year (day)

Year, month, date (day)

Date format
Display contents

[Delimiter] is [/] [Delimiter] is [-] [Delimiter] is [.]

2013年12月25日(水) 2013年12月25日(水) 2013年12月25日(水)

12/25(水) 12-25(水) 12.25(水)

13/12/25(水) 13-12-25(水) 13.12.25(水)

2013/12/25(水) 2013-12-25(水) 2013.12.25(水)

Time format Display contents

13:25 Hour:minute

13:25:45 Hour:minute:second

01:25(PM) Hour:minute (12-hour display format)

01:25:45(PM) Hour:minute:second (12-hour display format)

Hour:minute

Hour:minute:second

Hour:minute (12-hour display format)

Hour:minute:second (12-hour display format)

13時25分

13時25分45秒

午前01時25分

午前01時25分45秒

Object, function Display format

Alarm display
Date/Time formats

Logging

Date display Date format

Time display Time format

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.3.2 Date/time format settings

Click the button of the date/time setting item in the setting dialog of each object to display the [Date/Time Setting] dialog.
For how to set [Date Display] and [Time Display], refer to the following.

➟8.6 Placing a Date Display and Time Display

1) Preview
Displays a preview of the date and time.

2) [Contents]
Select the date and time to be displayed.
The following shows the items to be selected.

• [Date/Time]: Displays the date and time.
• [Date]: Displays only the date.
• [Time]: Displays only the time.

3) [Date Setting]
Set the display format of the date.

Item Description

[Sort]

Select a sorting order of year, month and date.
When [Change the sort setting along with language switching] is selected, a sorting order 
cannot be selected.
The following shows the items to be selected.
• [yy/mm/dd]
• [mm/dd/yy]
• [dd/mm/yy]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3)

4)
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[Date Type]

Select the display type of the date.
The items to be displayed differ depending on the selected item of [Delimiter] and [Fill with 
0].
The following shows the default items to be selected.
Example) To display Wednesday, December 25, 2013
• [25/12/13]
• [25/Dec]
• [25/DEC]
• [25/Dec(WED)]
• [25/DEC(WED)]
• [25/Dec/13]
• [25/DEC/13]
• [25/Dec/13(WED)]
• [25/DEC/13(WED)]
• [25/Dec/2013]
• [25/DEC/2013]
• [25/Dec/2013(WED)]
• [25/DEC/2013(WED)]
• [25/12/2013]
• [25/12/2013(WED)]
• [25/12]
• [25/12(WED)]
• [25/12/13(WED)]

• 

• 

• 

• 

• 

• 

• 

• 

• 

[Delimiter]

Select a delimiter used for separating expressions of year, month and date.
The following shows the items to be selected.
• [/]
• [-]
• [.]

[Fill with 0] When the month and/or date are/is in single digit, 0 is displayed before the single-digit 
number.

[Change the sort setting along with language 
switching]

Changes a sorting order of the date associating with language switching.
When the following items are selected in [Date Type], this function cannot be set.
• 

• 

• 

• 

• 

• 

• 

• 

• 

To use this function, set [Region Setting] in [Language Switching] of [Environmental 
Setting] window.
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

Item Description

[12月25日]
[12月25日(水)]
[13年12月25日]
[13年12月25日(水)]
[2013年12月25日]
[2013年12月25日(水)]
[12/25(水)]
[13/12/25(水)]
[2013/12/25(水)]

[12月25日]
[12月25日(水)]
[13年12月25日]
[13年12月25日(水)]
[2013年12月25日]
[2013年12月25日(水)]
[12/25(水)]
[13/12/25(水)]
[2013/12/25(水)]
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4) [Time Setting]
Set the display format of the time.

Item Description

[Time Type]

Select the display type of the time.
The display of the setting range differs depending on the selected item of [Fill with 0].
The following shows the default items to be selected.
Example) To display 13:25:45
• [13:25]
• [13:25:45]
• [01:25(PM)]
• [01:25:45(PM)]

• 

• 

• 

• 

[Fill with 0] When the time, minute, and/or second are/is in single digit, 0 is displayed before the single-
digit number.

[13時25分]
[13時25分45秒]
[午前01時25分]
[午前01時25分45秒]
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6.4 Color Settings

Set colors for objects, figures, and characters.
➟6.4.1 Specifications of colors

6.4.2 Color settings

6.4.1 Specifications of colors

■1 Available colors
65536 colors are prepared.

6.4.2 Color settings

Click the color set in each setting dialog or the button on the right of the color to display the color palette.

Select a color from the color palette.
➟■1 Color palette

■1 Color palette

1) Basic colors
Select a color to be displayed.

2) Custom colors
Select a color to be displayed.
When you specify a color in the dialog displayed with the [More Color] button, the color is added to the color palette.
The colors existing in the palette will not be added as a new one.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Color palette

Clicking here displays the color palette.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2)
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3) [More Color] button
Displays the [65536 Colors] dialog.

➟■2 [65536 Color] dialog
4) [Fill Effects] button

Displays the [Fill Effects] dialog.
Set the gradation or pattern.

➟■4 [Fill Effects] dialog

■2 [65536 Color] dialog

1) [Color]
Select a color to be displayed.

2) [Current Color]
Displays the currently set color.

3) [New Color]
Displays the color set in the following setting items.

• [Color]
• [Select] button
• [Color No.]

4) [Select] button
Changes the shape of the mouse cursor to a dropper and displays the color of the clicked position in [New Color].
When you move the mouse cursor with the display of the dropper, the color on which the cursor is placed is 
displayed in [New Color].

5) [Color No.]
Specifies a color to be displayed with its number from 256 colors.
The setting range is [0] to [255].
For each number of 256 colors, refer to the following.

➟■3 [256 Color] dialog
6) RGB value

Set a color to be displayed with three colors: red, green, and blue.

7) [256 Colors] button
Switches the dialog to the [256 Color] dialog.
If a color which cannot be displayed with 256 colors is set, the color is changed to an approximate color in 256 colors 
when the dialog is switched to the [256 Color] dialog.

Item Description

[Red] Set the display ratio of red.
The setting range is [0] to [255].

[Green] Set the display ratio of green.
The setting range is [0] to [255].

[Blue] Set the display ratio of blue.
The setting range is [0] to [255].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [256 Color] dialog

1) [Color]
Select a color to be displayed.

2) [Current Color]
Displays the currently set color.

3) [New Color]
Displays the color set in the following setting items.

• [Color]
• [Color No.]

4) [Color No.]
Specifies a color to be displayed with its number from 256 colors.
The setting range is [0] to [255].

5) RGB value
Indicates the numerical values of red, green, and blue for the selected color.

6) [65536 Colors] button
Switches the dialog to the [65536 Color] dialog.

■4 [Fill Effects] dialog

Set the fill effects, such as the gradation or pattern.
To apply the setting configured on a tab, click the [OK] button on the tab.

➟(1) [Gradation] tab
(2) [Pattern] tab

(1) [Gradation] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2) 3)

6)

5)
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1) [Color]
Select two gradient colors.

➟■1 Color palette
2) [Gradation Type]

Select a gradation type.
The following shows the items selectable for the logo text.

• [Horizontal]
• [Vertical]
• [Up Diagonal]
• [Down Diagonal]
• [From Edge]
• [From Edge (Round)]
• [From Center]

The following shows the items selectable for the screen background color.
• [Horizontal]
• [Vertical]
• [Up Diagonal]
• [Down Diagonal]

3) [Variation]
Select a gradient to be applied.
The displayed gradients vary depending on the setting of [Gradation Type].

(2) [Pattern] tab

1) [Color]
Select a foreground color and a background color for the pattern.

2) [Pattern]
Select a pattern.

GOT Graphic Ver.2

Item Description

[Foreground Color] Pattern color.

[Background Color] Pattern background color.

1)

2)
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6.4.3 Precautions

■1 Changing to an approximate color
When a color out of the range of 65536 colors is selected, the color is changed to an approximate color which is available 
in 65536 colors.
The changing method to an approximate color differs depending on the following setting items.

• Selecting a color with the [Color] or [Select] button
When the [OK] button is clicked, the color is changed to an approximate color.

• Setting a color by the RGB value
When the values of [Red], [Green], and [Blue] are input, the values are changed to approximate values.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.5 Placing and Editing Figures and Objects

Use figures and objects placing them on the screen.
For placements and settings common to both figures and objects, refer to the following.

➟6.5.1 Placing figures and objects
6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects
6.5.4 Common setting for figures
6.5.5 Common setting for objects

• Figures
With figures, characters and shapes can be designed.
Being unchanged according to devices and setting values, figures have no function other than being characters and 
shapes.
For available figures and the setting methods with GT Designer3, refer to the following.

➟7. FIGURES
• Objects

With objects, device values can be displayed, and characters and shapes can be designed.
The objects of each type have its own functions and change according to devices and setting values.
For available objects and the setting methods with GT Designer3, refer to the following.

➟8. OBJECT FUNCTION

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.5.1 Placing figures and objects

■1 Selecting figures and objects to be placed
Select figures and objects to be placed.

(1) Selecting from the menu
You can select a figure or an object to be placed from [Figure] or [Object] in the menu bar.

(2) Selecting from the tool bars
When the tool bars are displayed, figures and objects can be selected from the buttons in the tool bars.

For how to display the tool bars and for the types of buttons in the tool bars, refer to the following.
➟2.2.2 Toolbar and shortcut keys

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
6 - 136 6. BASIS OF SETTING AND EDITING
6.5 Placing and Editing Figures and Objects



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

(3) Selecting from the part image list
If figures have been registered in the list as parts, you can select them to place, from the part image list in the [Parts Image 
List] window.

For how to register parts and display the [Parts Image List] window, refer to the following.
➟5.9 Registering Parts ([Parts])

■2 Placing selected figures and objects
Place figures and objects you have selected on the screen editor.

(1) Placing without changing size
Place figures and objects in their default sizes.

Step 1 Select a figure or an object.
When a figure or an object is selected, the mouse cursor changes its shape.

Step 2 Move the cursor to the position where the figure or object is to be placed.
Step 3 In the following operation with the mouse or keyboard, the figure or object is placed.

• Mouse
Click.

• Keyboard
Press the [Enter] key twice.

(2) Placing with changing size
Place figures and objects in changing their sizes.

Step 1 Select a figure or an object.
When a figure or an object is selected, the mouse cursor changes its shape.

Step 2 Move the cursor to the position where the figure or object is to be placed.
Step 3 In the following operation with the mouse or keyboard, the size of the figure or object to be placed is 

changed.
• Mouse

Click and drag it to the desired position.
• Keyboard

Press the [Enter] key once and move the cursor key to the desired position.
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Step 4 In the following operation with the mouse or keyboard, the figure or object that has been changed in its size 
is placed.

• Mouse
Release the mouse button.

• Keyboard
Press the [Enter] key once.

■3 Changing the operation performed when figures and objects are placed
To change the operation performed when figures and objects are placed, set the following items on the [Edit] tab in the 
[Options] dialog.

• [Place figures/objects sequentially]
• [Deselect figures/objects once they are placed]
• [Display the setting dialog once figures/objects are placed]
• [Move figures/objects in the screen display area (move to temporary area with the Alt key)]

For how to display the [Option] dialog and for the operations with the above setting items, refer to the following.
➟11.10.4 Customizing the settings related to editing operations

■4 Placing a figure or object with guidelines
You can place figures and objects with the help of guidelines.

For how to display the guidelines, refer to the following.
➟2.6.9 Displaying guidelines

■5 Setting and checking the object ID
Object ID numbers are automatically set to figures and objects that are placed.
Users cannot change set object ID numbers.

(1) Range of the object ID numbers to be set
The setting range is [10000] to [64999].

(2) Retaining object ID numbers
Object ID numbers are retained by the project.

(3) Pasting copied or cut figures and objects
Pasted figures and objects have new object ID numbers.

(4) Checking object ID numbers
When [Object ID] is selected in the [Option] dialog, objects that are placed on the screen editor are displayed with their 
object ID numbers.
Figures are not displayed with object ID numbers.
For how to display the [Option] dialog and set the items in the dialog, refer to the following.

➟11.10.5 Customizing the display
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6.5.2 Selecting figures and objects on the screen editor

➟■1 Selecting figures and objects on the screen editor
■2 Selecting figures and objects in the [Data View] window
■3 [Data View] window

■1 Selecting figures and objects on the screen editor

You can select figures and objects by clicking the figures and objects on the screen editor with the mouse cursor.

(1) Selectable figures and objects on the screen editor
The target for selecting can be set in three ways: figures only, objects only, or figures and objects.
For how to select the target, refer to the following.

➟6.6.7 [Object of Selection]

(2) Selecting figures and objects that have been placed behind others
Click the overlapping part of the figures and objects while pressing the [Ctrl] key.
Figures can be selected one by one with each click.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Selected by
the first click.

Selected by 
the second click.

Selected by 
the third click.
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(3) Selecting multiple figures and objects
(a) Mouse drag operation

Drag to take the figures and objects in the square area.
When the mouse button is released, all the figures and objects in the area are selected.

(b) [Shift] key + Mouse operation
Click the figures and objects to be selected while pressing the [Shift] key.

(4) Deselecting figures and objects
Click the targets for deselecting in a selection of multiple figures and objects, while pressing the [Shift] key.

■2 Selecting figures and objects in the [Data View] window

The [Data View] window displays the list of the figures and objects displayed on the screen editor being edited.
If you select a figure or an object displayed in the [Data View] window, the corresponding figure or object on the screen 
editor is selected.
For how to display the [Data View] window and set the items in the window, refer to the following.

➟■3 [Data View] window

1. Drag

2. Release the mouse button.

Click multiple figures and 
objects while holding the 
[Shift] key to select them.

Click the selected figures 
and objects while holding 
the [Shift] key to deselect 
them.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [Data View] window

Select [View] → [Docking Window] → [Data View] from the menu to display the setting window.

1) [Data View]
Displays the screen type, screen number, and title of the screen editor being edited and the layers displayed on the 
editor.

2) Objects to be displayed
Select whether to display the figures and objects in the data view or not.

3) [Number of Objects]
Displays the number of the objects placed in the screen editor.
The number is displayed regardless of the [Objects] setting.
As to figures, only those with the lamp attribute setting are counted in as objects.

4) Data view
Displays the list of the figures and objects which are placed on the screen editor being edited.
The items in the list depend on the [Objects] and [Figures] settings.

Item Description

[Objects] Displays the objects in the data view.

[Figures] Displays the figures in the data view.

Item Description

[Figure/Object] Displays the names of the figures and objects.

[Name] Displays the set names if they have been set for [Name] of the figures and objects.

[Position] Displays the coordinates of the figures and objects which are placed on the screen editor.

[Layer] Displays the layers in which the figures and objects are placed.

[Object ID]

Displays the object ID numbers which are set for the objects.
As to figures, what are displayed depend on whether or not the lamp attribute has been set.
• If the lamp attribute has been set

[-] is displayed.
• If the lamp attribute has not been set

Nothing is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

4)

The layer (s) being 
displayed

Screen type - screen 
number

Title
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6.5.3 Editing figures and objects

➟■1 Operating with the menu
■2 Moving, enlarging, or reducing a figure or object with guidelines
■3 Changing sizes
■4 Changing the attributes in the property sheets

■1 Operating with the menu
Edit selected figures and objects with the [Edit] menu.
For the items in the [Edit] menu and restrictions on the items, refer to the reference for each editing operation.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Editing operation Reference

Canceling the last operation or redoing the canceled operation ➟6.6.1 [Undo], [Redo]

Copying or cutting figures and objects and pasting them ➟6.6.2 [Cut], [Copy], [Paste]

Copying and pasting figures and objects simultaneously ➟6.6.3 [Duplicate]

Copying and pasting figures and objects specifying the number of them 
and the interval between them ➟6.6.4 [Consecutive Copy]

Deleting figures and objects ➟6.6.6 [Delete]

Grouping two or more figures and objects or releasing them from grouping ➟6.6.8 [Group], [Ungroup]

Changing the display order of figures and objects on the screen editor ➟　 6.6.9 ■1 [Move to the Front of Front Layer]

　 6.6.9 ■2 [Move to the Back of Back Layer]

Changing the display order of objects in the same layer

➟　 6.6.9 ■3 [Move to the Front of Layer]

　 6.6.9 ■4 [Move to the Back of Layer]

　 6.6.9 ■7 [Move to the Front]

　 6.6.9 ■8 [Move to the Back]

Aligning the display positions of multiple figures and objects ➟6.6.10 [Align]

Flipping figures and objects ➟　 6.6.11 ■1 [Flip Vertical]

　 6.6.11 ■2 [Flip Horizontal]

Rotating figures and objects ➟　 6.6.11 ■3 [Rotate Left]

　 6.6.11 ■4 [Rotate Right]

Moving the vertexes of figures ➟6.6.12 [Edit Vertices]

Fixing the frame width of the object shape when the object is resized ➟6.6.13 [Edit Objects with Fixed Frame Width]

Selecting whether to adjust the touch areas of objects automatically or 
manually ➟6.6.14 [Edit Touch Area]

Scaling the texts set on objects in proportion to the object sizes ➟6.6.15 [Adjust Direct Text Size]

Setting categories of figures and objects ➟6.6.19 [Add to Category]

Changing the shapes of objects ➟6.6.20 [Shape Change]
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■2 Moving, enlarging, or reducing a figure or object with guidelines
You can move, enlarge, or reduce a figure or object by using the guidelines as the reference.

For how to display the guidelines, refer to the following.
➟2.6.9 Displaying guidelines

■3 Changing sizes
Change the sizes of figures and objects.

(1) Types of handles
The point that appears around selected figures and objects is called "handle".
There are two types of handles:

• Size change handle
Use this handle to change the sizes of figures and objects.

• Vertex edit handle
Use this handle to edit the sides of figures.

For how to switch between the types of the handles, refer to the following.
➟6.6.12 [Edit Vertices]

(2) Resizing a figure
Resize a figure.
If the vertex edit handles have been displayed, switch to the size change handles.
The following shows the procedure for resizing a figure.

Step 1 Select a figure.
Step 2 The handles are displayed around the figure.
Step 3 Drag a handle with the mouse cursor to change the size of the figure.

Move Enlarge Reduce

Size change handle

Vertex edit handle
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(3) Resizing an object
Resize an object.
If the vertex edit handles have been displayed, switch to the size change handles.
The following shows the procedure for resizing an object.

Step 1 Select an object.
Step 2 The handles are displayed around the object.
Step 3 Drag a handle with the mouse cursor to change the size of the object.

The sizes of the following objects are determined according to the text sizes that the objects display.
When sizes need to be changed, change the text sizes in the setting dialogs for the objects.

• Alarm display
• Historical data list

(4) Operations in combination of the [Ctrl] key, the [Shift] key, and the [Alt] key
The size changing method can be changed in combination of the [Ctrl] key, the [Shift] key, and the [Alt] key.

• Dragging handles while pressing the [Ctrl] key
The sizes of figures and objects can be changed symmetrically about their centers.

• Dragging handles while pressing the [Shift] key
The sizes can be changed with their horizontal-to-vertical ratios fixed.

• Dragging handles while pressing the [Ctrl] and [Shift] keys
The sizes of figures and objects can be changed symmetrically about their centers with the horizontal-to-vertical 
ratios fixed.

• Dragging handles while pressing the [Alt] key

Example) Size change in the horizontal direction Example) Size change in the vertical and horizontal 
directions with the base point of the corner

012345

012345
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The [Snap] setting in the [Option] dialog becomes invalid and the sizes can be changed in dots.
➟11.10.5 Customizing the display

(5) Resizing multiple figures and objects
Resize the selected figures and objects collectively.

(6) Resizing the text displayed on an object
Text other than direct text automatically change their sizes in proportion to the changes of the objects sizes.
Whether or not the text sizes are automatically changed depends on the type of the objects.

The font type is automatically switched between 12-dot Standard and 16-dot Standard (Gothic) according to the changed 
text size.

(7) Resizing the text when [Text Type] is set to [Text]
When [Adjust Direct Text Size] is selected, the text displayed on one of the following objects is resized automatically 
according to the object size.

• Touch switch
• Word lamp
• Bit lamp
• Graphical meter
• Panelmeter
• Hyperlink

For how to set [Adjust Direct Text Size], refer to the following.
➟6.6.15 [Adjust Direct Text Size]

Tex size (changed/
unchanged) Object Description

Changed

• Numerical Display
• Numerical Input
• Text Display
• Text Input
• Date Display
• Time Display

The text sizes are enlarged by 0.5 to 8 times in proportion to the changes of the object 
sizes.
Example) When the size of an object for numerical display is changed

Unchanged

• Touch Switch
• Bit Lamp
• Word Lamp
• Comment Display
• Historical Data List Display
• Alarm Display
• Recipe Display (Record 

List)
• Line Graph
• Trend Graph
• Bar Graph
• Statistics Bar Graph
• Statistics Pie Graph
• Scatter Graph
• Historical Trend Graph
• Graphical Meter
• Panelmeter
• Slider
• Hyperlink

Change the text sizes with the text size setting of each object.
The text sizes are not changed automatically even if the object sizes are changed.
Example) When the size of a touch switch is changed
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The font type is automatically switched between 12-dot Standard and 16-dot Standard (Gothic) according to the changed 
text size.

(8) Resizing the text when [Text Type] is set to [Comment]
When [Adjust Text Size] is selected in the object setting dialog, the text is resized automatically according to the object 
size.
(The text displayed in a Windows font is not enlarged automatically, and is reduced differently from the one displayed in 
a non-Windows font.)
The minimum text size to be adjusted is settable with [Minimum Size].
The following shows the objects for which [Adjust Text Size] and [Minimum Size] are settable.

• Touch switch
• Bit lamp
• Word lamp
• Comment display
• Historical data list display
• Alarm display
• Recipe display (Record list)
• Graphical meter
• Hyperlink

If a part of the text extends off the display frame, the text appears differently according to the setting of [Adjust Text Size] 
as shown below.

When [Adjust Direct Text Size] is enabled

When [Adjust Direct Text Size] is disabled

Text to be displayed on the object
[Adjust Text Size]

Selected Deselected

• Font other than a Windows font
The text is resized automatically to fit on 
the display frame.

• Font other than a Windows font
The portion of the character string that 
has been extending off the frame starts a 
new line to fit in the display frame.

• Windows font
The text is resized automatically to fit on 
the display frame.

• Windows font
Even if a part of the text extends off the 
display frame, the text does not wrap to 
the next line.
The part extending off the frame is not 
displayed.
(If a character straddles the frame, only 
the part of the character within the frame 
is displayed.)

ABCDEFGH

Display frame

Character string 
to be displayed

ABCDEFGH ABCDE
FGH

ABCDEFGH

ABCDEFGHABCDEFG
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If the HG font is used, the appearance of the font may change after the change of the size.

If the appearance has been changed, adjust the size of the object so that the appearance returns to that of the HG font.

(9) Resizing the shape of an object
The shape of an object is resized according to the object size.
The resize behavior of the shape frame width varies according to the shape type and the frame width fixing setting.

• Font other than a Windows font
After the text is displayed in the size 
specified with [Minimum Size], if a part of 
the text still extends off the display frame, 
the part is not displayed.
(If a character straddles the frame, the 
character is not displayed.)
The text is displayed left aligned.

• Font other than a Windows font
After the text wraps to the next line, if a 
part of the text still extends off the display 
frame, the part is not displayed.
(If a character straddles the frame, the 
character is not displayed.)

• Windows font
After the text is displayed in the size 
specified with [Minimum Size], if a part of 
the text still extends off the display frame, 
the part is not displayed.
(If a character straddles the frame, only 
the part of the character within the frame 
is displayed.)
The text alignment is not changed.

• Windows font
Even if a part of the text extends off the 
display frame, the text does not wrap to 
the next line.
The part extending off the frame is not 
displayed.
(If a character straddles the frame, only 
the part of the character within the frame 
is displayed.)

Text to be displayed on the object
[Adjust Text Size]

Selected Deselected

ABCDEFGH

Display frame

Character string 
to be displayed

ABCDEF GH

ABC
DEF GH

ABCDEFGHABCDEFG ABCDEFGHABCDE

Shape type Resize behavior of the shape frame width

Library
System Library

The resize behavior of the frame width varies according to the frame width fixing 
setting.

➟6.6.13 [Edit Objects with Fixed Frame Width]
• When the frame width fixing setting is enabled

For the object shape to which the setting is applicable, resizing the object does not 
change the frame width.

For the object shape to which the setting is inapplicable, resizing the object resizes 
the frame width.

• When the frame width fixing setting is disabled
Resizing an object resizes the frame width.

My Library Resizing an object resizes the frame width.
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(10)Resizing the touch area
When you set a shape for an object, resizing the object may make the touch area and the shape different-sized and 
misaligned.
In such a case, select the object and perform the following operations to adjust the touch area and the shape.

• Centering the touch area in the shape
Right-click the object and select [Centering] from the right-click menu.
The touch area is centered in the shape.

• Editing the touch area and the shape separately
Select the object, and then select [Edit] → [Edit Touch Area] → [Manual Edit] from the menu.
The sizes and display positions of the touch area and the shape can be edited separately.

• Making the shape and the touch area fit into each other
Select the touch switch, and then select [Edit] → [Edit Touch Area] → [Self-adjust] from the menu.
The shape and the touch area fit into each other.

• Always adjusting the shape and the touch area automatically
Select [Edit] → [Edit Touch Area] → [Constant Self-adjust] from the menu.
For all objects, their shapes and touch areas are always adjusted automatically.

Basic Figure

The resize behavior of the frame width varies according to the shape state.
For the shape with a fixed frame width, the shape name includes [Fixed Width].

• For the object shape with a fixed frame width
Resizing an object does not change the frame width.

• For the object shape with a variable frame width
Resizing an object resizes the frame width.

Shape type Resize behavior of the shape frame width
6 - 148 6. BASIS OF SETTING AND EDITING
6.5 Placing and Editing Figures and Objects



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

■4 Changing the attributes in the property sheets
Figure and object settings can be changed in the property sheets.

For how to display the property sheets and set in the property sheets, refer to the following.
➟11.9 Checking and Editing Settings of Screens and Objects (Property Sheet)

6.5.4 Common setting for figures

➟■1 Lamp attribute setting

■1 Lamp attribute setting

(1) Figures for which the lamp attributes can be set
The following lists the figures for which the lamp attributes can be set.
For how to set the lamp attributes, refer to the setting dialog of each figure.

(2) Display and operation when the lamp attribute is set
The figure having the lamp attribute setting changes its display color and operates in the same manner as a bit lamp.

(3) The maximum number of figures per screen
When figures that have the lamp attributes set for them are placed on the screen editor, they are counted as lamps.
For the maximum number of lamps per screen, refer to the following.

➟1.2.3 ■3 Functions arrangeable on the screen

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Figure Reference

Line ➟7.3 Drawing a Line

Freeform line ➟7.4 Drawing a Line Freeform

Rectangle ➟7.5 Drawing a Rectangle

Polygon ➟7.6 Drawing a Polygon

Circle ➟7.7 Drawing a Circle

Piping ➟7.11 Drawing a Piping
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6.5.5 Common setting for objects

➟■1 Setting object shapes
■2 Setting conditions
■3 Superimposition
■4 Setting data operations

■1 Setting object shapes

Setting shapes for objects spruces up the displays of the objects.
There are two types of shapes: those for external forms such as a lamp and those for frames, such as a numerical display 
and graph.

• Shapes for external forms

• Shapes for frames

(1) Specifications of object shapes

(a) Image types that can be set for objects
Images can be selected from the basic figures, library, or parts

(b) Applying shapes to two or more conditions or both the on and off statuses for a single object
Shapes can be applied to each condition, the on status, and the off status.
However, the basic figures, library, and parts cannot be mixed.

(c) Selecting shapes from the favorite in the library, my library, or parts
Shapes cannot be selected if they have not been registered in the library or as parts.
For how to register shapes in the library and as parts, refer to the following.

➟5.9 Registering Parts ([Parts])
　 8.1.2 ■2 Registering the data in the library

(2) How to use object shapes

The following shows the procedure for setting a shape for an object.
Example) setting a shape for a bit lamp

Step 1 Place a bit lamp on the screen editor and display the setting dialog.
Step 2 Click the [Shape] button in the [Device/Style] tab to display the [Image List] dialog.

➟(3) [Image List] dialog
Step 3 In the [Image List] dialog, select the shapes for the on and off statuses.
Step 4 After selecting the shapes, click the [OK] button of the [Image List] dialog and setting dialog to complete the 

shape settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) [Image List] dialog

This section explains each setting item using the setting dialog for a bit lamp.
Different types of objects have different necessary setting items. Refer to the setting items explained in this section that 
are provided for the object to be used.

1) [Display Shape]
Displays the image for each condition or the on/off status.
When selecting different images for each condition, or for the on and off statuses, select the target object with this 
setting item.

2) Image types
This item is not displayed when the target object has one selectable image type only.
Select the image type of the shapes.
The following shows the items to be selected.

• [Basic Figure]
• [Library]
• [Parts]

3) Types of the basic figure or library
Can be set if [Basic Figure] or [Library] is selected for the image type.
Select shape types from the basic figure or library.

4) [Set OFF and ON at the same time], [Set every state at the same time]
Different objects have different setting items.

• [Set OFF and ON at the same time]
Sets the same shape for both objects displayed in [ON] and [OFF] of [Display Shape].

• [Set every state at the same time]
Sets the same shape for all the conditions displayed in [Display Shape].

5) Shape image list
Select the shape to be set for the object.

6) [Jump] button

Item Description

[ON] button, [OFF] button Switches between displaying the on status image and off status image in [Display Shape] 
and the shape image list.

Library theme button Can be set only when [Library] is selected for the image type.
Select the type of the library.

Color category button Changes the color category of the shape image list.

[Register Here] button

Can be set only when items other than [System Library] are selected with the library theme 
button.
Registers in the favorite or my library the shapes selected for [Display Shape] and in the 
shape image list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

4)

5)

Library theme 
button

Color category button

When [Library] is selected for [Display Shape]

6)

3)
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Specify a number shown in the shape image list and click the [Jump] button to select the shape associated with the 
specified number.

■2 Setting conditions

If conditions are set, colors, shapes, and characters set for the object can be changed according to the on/off statuses of 
bit devices and the values of word devices.

(1) Specifications of conditions

(a) Settable conditions
The following lists the conditions that can be set for objects.

• ON or OFF status of bit devices
• Values of word devices
• Values of word devices that the objects monitor

(b) Objects for which the conditions can be set
The following shows the objects for which the conditions can be set and the conditions that can be set for each object.

*1 Must be the values of the word devices being monitored.

(c) The maximum number of conditions set for a single object
Up to 64 types of conditions can be set.

(d) Order of the priority given to displays
If two or more conditions overlap, the display that results from a satisfied condition with smaller No. is prioritized.
If all the conditions 1 to 63 are not satisfied, the display for the condition 0 is shown.

Example) If condition 1 and condition 2 are satisfied simultaneously

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Object Condition

Word lamp

• On and off statuses of bit devices
• Values of word devices
• Values of word devices that the objects monitor

Numerical display

Parts display (Word part)

Parts movement (Word part)

Numerical input

• Values of word devices*1

• Values of word devices that the objects monitor

Comment display (Word comment)

Level object

Panelmeter

Scatter graph

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Condition number Priority

0 (normal) Low

High

The display attribute which must be set for each object. 
If other conditions (1 to 63) are not satisfied, the attribute 
of the condition 0 is displayed.

1

63

:

:
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(2) How to use conditions

(a) The operating examples of conditions
• Changing the display according to the on and off statuses of a bit device

Example) Setting the following conditions for a numerical display
If M10 is on, the shape color changes to black.

• Changing the display according to the value of a word device
Example) Setting the following conditions for a numerical display
If condition 1, 5 <= D100 <= 9, is true, the shaped color changes to gray.
If condition 2, 10 <= D100, is true, the shape color changes to black.

• Changing the display according to the value of a word device being monitored
Example) Setting the following conditions for a level display
If condition 1, D100 = 40, is true, the shape color changes to light gray.
If condition 2, D100 = 60, is true, the shape color changes to gray.
If condition 3, D100 = 90, is true, the shape color changes to black.

(b) Setting example of conditions
The following shows a setting example of conditions.
For details of the setting items, refer to the setting dialog of each object.
Example) Setting condition 0 to condition 2 for a numerical display

• If condition 1, 5 <= D100 <= 9, is true, the shape color changes to gray.
• If condition 2, 10 <= D100, is true, the shape color changes to black.

Contents to be
 displayed Display condition

50 ≤ D100

0 ≤ D100

Condition 1

Condition 2

D100: 80

Not displayed

Displayed by the condition 1.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Word device being monitored: 
D500 (Temperature) 
Bit device set to the condition: 
M10 (Turns on when an error occurs)

30°C 30°C

Since M10 turned on due to an error, 
the display is changed.

M10 = OFF
D500 = 30

M10 = ON
D500 = 30

Word device being monitored: 
D500 (Production quantity) 
Word device set for the condition: 
D100 (Quantity of defective products)

50 150

The display is changed when quantity of 
defective products exceeds a specified amount.

D500 = 30

5 <= D100 <= 9

D500 = 150

10 <= D100

D500 = 200
D100 = 0 D100 = 7 D100 = 12

200

Word device being   
a monitored: D100

Changing the color according to the value of a word 
device being monitored

D100 = 40 D100 = 60 D100 = 90
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Step 1 Place a numerical display on the screen editor and display the setting dialog.
Step 2 Set condition 0 in the [Style] tab.

If both condition 1 and 2 have not been satisfied, the shape which has been set for condition 0 is displayed.
• Numerical Color: Black
• Blink: None
• Reverse: Unchecked
• Shape Color: White
• Frame Color: Green

Step 3 Set condition 1 in the [Style] tab.
• Click the add button to create condition 1.
• Condition 1: 5 < = D100 < = 9
• Numerical Color: Black
• Blink: None
• Reverse: Unchecked
• Shape Color: Gray
• Frame Color: Green

For the setting dialog displayed by clicking the [Range] button, refer to the following.
➟(3) [Edit Range] dialog

Word device being monitored:
D500 (Production quantity) 

Condition 0 Condition 1 Condition 2

Word device set for the condition: 
D100 (Quantity of defective products)

50 150

The display is changed when 
quantity of defective products 
exceeds a specified amount.

D500 = 30

5 <= D100 <= 9

D500 = 150

10 <= D100

D500 = 200
D100 = 0 D100 = 7 D100 = 12

200
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Step 4 Set condition 2 in the [Style] tab.
• Click the add button to create condition 2.
• Condition 2: 10 < = D100
• Numerical Color: White
• Blink: None
• Reverse: Unchecked
• Shape Color: Black
• Frame Color: Green

For the setting dialog displayed by clicking the [Range] button, refer to the following.
➟(3) [Edit Range] dialog

Step 5 Click the [OK] button of the setting dialog to complete the shape settings.
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(c) Display example of overlapping conditions
If conditions are overlapped, the condition of smaller No. is prioritized.
Example)
Setting conditions for a numerical display

• Monitored device: D500
• Data type: Signed 16-bit binary data

(3) [Edit Range] dialog

Displayed by clicking the [Range] button in the object's setting dialog.
Depending on the type of the object, the setting items in the setting dialog differ.
Refer to the setting items explained in this section that are provided for the object to be used.

Order of priority given to 
operations when they 

overlap
Condition No. Value range with which the set color 

is displayed Numerical value color

High
↓
Low

1 M10: ON Red (with blink)

2 200 <= $V <= 300 Blue

3 1000 <= $V Yellow (inverted)

Condition 0 (normal) - Green

Condition 1 If M10 turns on, the numerical value is displayed in red (with blink).

Condition 2 If the value of the monitor device is 200 to 300 (200 <= $V <= 300), the 
numerical value is displayed in blue.

Condition 3 If the value of the monitor device value is 1000 or greater (1000 <= $V), the 
numerical value is displayed in yellow (inverted).

Condition 0 (normal) If the condition is other than condition 1 to 3, the numerical value is displayed 
in green.

150

200

3000

150

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2)
3)
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1) Range expression
Range expression that has been set.

2) Relational operators
Select relational operators used in the range expression.
The following shows the items to be selected.

• [<]: The left side value is smaller than the right side value.
• [<=]: The left side value equals or smaller than the right side value.
• [==]: The left side value equals the right side value.
• [!=]: The left side value and the right side value are different.
• [None]: Not compared.

3) [Constant Data Type]
Select the data type if [Constant] has been selected for [Term Type] of the range expressing setting.
This item is available if other than [Real] is set for [Data Type] when setting [Range] of [Trigger Type].
The following shows the items to be selected.

• [Hex]
• [Dec]
• [Oct]

4) Range expression setting

Device range setting when [Data Type] is [Real]
For a device whose [Data Type] is [Real], the GOT and a controller handle the device value a little differently.
If you set a precise input condition using [==] or [!=], the input range may not be checked properly.
When checking the input range with such a device, do not use [==] and [!=] to set the input condition.
For the data type specifications, refer to the following.
➟1.2.7 ■2 Data type of devices

■3 Superimposition

Windows can be displayed in superimposition in layers and on the same screen.
➟(1) Specifications of superimposition

(2) Using layers
(3) Not using layers
(4) Special superimposition
(5) Precautions

(1) Specifications of superimposition

In superimposition, figures and objects are placed and displayed in the same layer or multiple layers.
For the layers, refer to the following.

➟1.2.3 ■2 (5) Layer

Item Description

[Term Type]

Select the type and value of each side (A to C) of the range expression.
The following shows the items to be selected.
• [Constant]:

Operates with constants.
• [$V], [$W], monitor device:

Operates the value of the target word device for monitoring or writing.
If a monitor device is selected, the target word device that has been set is displayed.
Set this item in the range expression as it is compulsory.

• [Other Device]:
Operates the value of a word device.
The data type is the same as the device to be monitored ([$V], [$W], monitor device)

[Value]

Select the value of each side (A to C) of the range expression.
Depending on the [Term Type], the setting item differs.
• When [Constant] is selected: Set a numerical value.
• If [$V], [$W], or monitor device: The target device for monitoring is displayed.
• When [Other Device] is selected: Set a device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Display method
The following shows how to display figures and objects in superimposition.

(b) Figures and objects that are displayed in the topmost position in the layer at all times
The following figures and objects are displayed in the topmost position in the layer at all times.

• Alarms: If [Display Type] is set to [Flow]
• Scatter graphs: If [Store Memory] is set
• Figures drawn by the free figure drawing function of the object scripts

(2) Using layers

A base screen and a window screen consist of two layers: the front layer and the back layer.
Two objects can be superimposed by placing objects and figures separately in each layer.

Display method Description Windows for which superimposition is enabled

Superimposing in the same layer

The object stacking order on the GOT conforms to 
that on GT Desiger3.

If [Adjust object display order in GOT to the one in GT 
Designer3] of the [Type Setting] dialog is checked, 
the display order arranged on GT Designer3 is 
ensured when the figures and objects are displayed 
on the GOT.

➟5.1.5 [Type Setting] dialog

If objects are superimposed in the same layer, the 
objects are not displayed or operate normally 
depending on the type of objects.
For the objects that are displayed and operate 
normally in the same layer, refer to the following.

➟(3) Not using layers

• Base screen
• Overlap window
• rimpose window
• Dialog window
• Key window
• Mobile Screen

Superimposing in the use of the 
front and back layer

Figures and objects can be displayed in 
superimposition if they are placed separately in the 
front layer and the back layer.
For the superimposition using the layers, refer to the 
following.

➟(2) Using layers
(4) Special superimposition

• Base screen
• Overlap window
• rimpose window
• Key window
For windows other than those listed above, the object 
stacking order on the GOT may differ from that on GT 
Desiger3 because the layers are combined into one 
layer.
In such a case, enable the object stacking order 
adjustment so that the object stacking order on the 
GOT conforms to that on GT Desiger3.

➟5.1.5 [Type Setting] dialog

GOT Graphic Ver.2

GOT Graphic Ver.1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Front layer

Actual display

Back layer 
  Displayed behind the front layer.

Displayed as a transparent sheet. 
The areas other than the ones on which figures and objects 
are arranged are transparent and the back layer is displayed. 
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(a) Figures and objects which can be placed in each layer

(b) Screens on which the layers are enabled, and the display order of figures and objects
The display order of figures and objects placed in the front layer and back layer may or may not follow the order of the 
layers.

The following shows the display order of figures and objects on each screen.

Layer Available figures and objects

Front layer Figures (Pipings with the lamp attribute), objects

Back layer Figures, objects

Screen type Layer Display order of objects on the GOT

Base screen

Valid

Displayed in order of the layers.

Windows called on base screens 
by the set overlay screen function

Displayed in order of the layers.

Superimpose window

Valid

Displayed in order of the layers.

Windows called on superimpose 
windows by the set overlay screen 
function

Displayed in order of the layers.

    

125A

125A

    

When objects are not displayed in the order of the layers

When objects are displayed in the order of the layers

Objects on the front layer are always 
displayed at the front.

Superimposed objects are not correctly displayed. 
The order of the layers does not depend on the 
settings of the front and back layers.

Front layer

Back layer

Numerical display (Front layer)

Bar graph (Front layer)

Base screen

Numerical display (Front layer)

Bar graph (Front layer)

   Called screen 
(Window screen 1)

Numerical display (Front layer)

Bar graph (Front layer)

Superimpose window

Numerical display (Front layer)
  Bar graph 
(Front layer)

   Called screen 
(Window screen 1)

Superimpose window
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(c) Transparent color

The transparent color is set for the front layer.
The part of an object that is in the same color as the transparent color has transparency.
To make an object transparent, match the transparent color with the color of the part of the object.
Set the transparent color for the front layer in the [Screen Property] dialog.
For how to set the [Screen Property] dialog, refer to the following.

➟2.7 Changing Screen Property
This function is not available on windows, such as a dialog window, where the layers are combined into a single one when 
they are displayed on the GOT.
If an object for which the same color as the transparent color of the front layer is set is placed on windows such as a dialog 
window, the object is displayed in the set color without transparency.
Example) If transparent colors are set for superimpose windows and dialog windows

Overlap window

Valid

Displayed in order of the layers.

With GT23, the layers are combined into a single layer and displayed.

Windows called on overlap 
windows by the set overlay screen 
function

Displayed in order of the layers.

With GT23, the layers are combined into a single layer and displayed.

Key window Valid

Displayed in order of the layers.

With GT23, the layers are combined into a single layer and displayed.

Dialog window Invalid

The layers are combined into a single layer and displayed.

Screen type Layer Display order of objects on the GOT

Numerical display (Front layer)

  Bar graph 
(Front layer)

Overlap window

Numerical display (Front layer)
 Bar graph 
(Front layer)

Overlap window
   Called screen 
(Window screen 1)

Numerical display (Front layer)

Key code switch

Key window

ABCDE

ABCDE Touch switch 
 (Front layer)

Comment display (Back layer)

Dialog window

GOT Graphic Ver.1
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(d) Superimposing two or more windows using the layers
The following shows how the layers and the transparent colors act when superimpose windows and set overlay screen 
function are used to superimpose and display two or more windows.

• Layers
The front layers and back layers that have been set for two or more windows are combined into a single front layer 
and back layer when the screen are superimposed.
Superimposed objects on the combined layers may not be displayed or operate normally.
When superimposing windows, prevent the objects in the front layers or back layers from being superimposed.

Certain objects can be displayed and operate normally.
For the objects that can be superimposed in the same layer, refer to the following.

➟(3) Not using layers
• Transparent colors

The transparent colors for superimpose windows and called windows are ignored and the transparent colors for the 
base screens are enabled.
To make the objects transparent, match the colors with the transparent colors for the base screens.

Front layer 
(Transparent 
color: Black)

Back layer

Bar graph

Numerical display 
(Color in the frame: Blue)

Transparent color: Black

Since the transparent color 
is different from the color in
the frame, it does not 
become transparent.

12451245

Blue
Transparent color: Blue

Blue

Since the transparent color
 is the same as the color in 
the frame, it becomes 
transparent.

     The 
transparent 
  color is 
 changed 
  to blue

Actual display

     When the transparent color is set to a superimpose window
     (Layers are not combined when displayed on the GOT.)

Actual display

     When the transparent color is set to a dialog window
     (Layers are combined when displayed on the GOT.)

Transparent color: Black

Since the transparent color 
is different from the color in 
the frame, it does not 
become transparent.

Blue

1245 1245
   Transparent color: Blue

Blue

Even though the transparent 
color is the same as the color 
in the frame, it does not
become transparent.

    The 
transparent 
  color is 
changed 
  to blue

Front layer

Back layer

Actual display

Base screen 1 Window screen 1

Window screen 1 is
 displayed as a 
superimpose window.

Since the objects are superimposed, 
they are not properly displayed.

GOT Graphic Ver.1
6. BASIS OF SETTING AND EDITING
6.5 Placing and Editing Figures and Objects

6 - 161



(3) Not using layers

Certain objects can be displayed and operate normally even when they are superimposed in the same layer.
The following lists the objects that can be superimposed in the same layer.

(a) Superimposition with touch switches
Touch switches without figures and texts can be used in superimposition with the other objects.

The following lists the objects that can be superimposed with touch switches.

Front layer

Lamp color: Red

    When the called screen is displayed as it is 
    (The lamp color is red)

    When the color of the object is changed 
    according to the transparent color of the 
    basic screen (The lamp color is changed 
    from red to blue.)

The object on the called screen is 
displayed as the original image.

Becomes
transparent.

Does not 
become 
transparent.

The transparent color of the basic figure
is enabled and the lamp color 
(unwanted area) becomes transparent.

The base screen 
100 is overlaid on 
the base screen 1.

Transparent 
color: Red

Transparent
 color: Black

Base screen 1 
(Basic screen)

Base screen 100 
(Called screen)

Back layer

Actual 
display

Combination Reference

Touch switch and the other objects (a) Superimposition with touch switches

Level object, numerical display, comment display (b) Superimposition with level objects

Parts display and parts display (c) Superimposition of parts displays

Objects that can be superimposed with touch switches

Lamp Numerical display*1 Numerical input Text display*1

Text input Date display Time display Comment display

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

    Combination of a touch switch and the other objects

    Level object + numerical display
                           /comment display

    Parts display + Parts display

    Figure + Object

The object is displayed 
on the figure.

+

+

+

+

50

Touch switch 
(without figures)

Although the touch switch is not displayed,
it responds when touched.

Lamp display
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*1 To superimpose a numerical display and a text display, place them in separate layers.

➟(2) Using layers
*2 An alarm display with a touch operation arranged for it cannot be superimposed with touch switches.

When superimposing touch switches with objects, do not make the following settings for the touch switches.
• Selecting items other than [None] for [Shape] in the [Style] tab
• Setting [Reverse switch area] if [None] has been selected for [Shape] in the [Style] tab
• Selecting [Text] for [Text Type] in the [Text] tab and then inputting a text to [Text]

For how to set touch switches, refer to the following.
➟8.2 Placing a Touch Switch

(b) Superimposition with level objects
The numerical display, numerical input, and comment display objects can be superimposed on the level object.
Multiple objects can be superimposed on one level object.

For a level object, the boundary color cannot be set.
For a numerical display or comment display, [Display Mode] is fixed to [Transparent].
For superimposing objects on a level object, refer to the following.

➟8.23.2 How to use the level object (GOT Graphic Ver.2)

For superimposing objects on a level object, refer to the following.
➟8.23.3 How to use the level object (GOT Graphic Ver.1)

Depending on the display mode of the objects with which levels objects are superimposed, the displays of the level 
objects differ.
The following shows application examples.
Example 1) When [Display Mode] is set to [Transparent] for a numerical display, numerical input, or comment display
The numerical display color and text color are displayed as is.

Example 2) When [Display Mode] is set to [XOR] for a numerical display, numerical input, or comment display
When the target object is superimposed on the fill color portion of the level object, the color of the overlapping portion is 
inverted in the target object.
However, inputting a value on the numerical input does not apply the fill color of the level object to the overlapping portion 
of the numerical input.
The new value is not reflected to the display until you touch the numerical input again.

(c) Superimposition of parts displays

Two or more parts can be displayed in superimposition.
Select [Overwrite] for [Display Mode] of parts displays.

Parts display Parts movement Historical data list display Alarm display*2

Level object Panelmeter Line graph Trend graph

Bar graph Statistics bar graph Statistics pie graph Scatter graph

Historical trend graph Hyperlink

Objects that can be superimposed with touch switches

GOT Graphic Ver.2

GOT Graphic Ver.1

20 48 98

FULL FULLFULLFULL

GOT Graphic Ver.1
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(4) Special superimposition

By using superimpose windows and the set overlay screen function, and multiple placements on the same screen, up to 
eight objects including touch switches, numerical inputs, and character string inputs set for each window can be 
superimposed.

(a) Special method for superimposing touch switches, numerical inputs, and character string inputs
• Superimposition with superimpose windows

Superimpose windows are superimposed in front of the base screen, and displayed as a single window.
For the specifications of the superimpose window, refer to the following.

➟1.2.3 Screen types and the specifications

• Superimposition with the set overlay screen function
Calling base screens and window screens on basic screens (base screens and superimpose windows), this function 
displays them as a single screen.
For how to set the set overlay screen function, refer to the following.

➟8.29 Placing Another Screen on a Screen

• Superimposition by multiple placements on the same screen (for touch switches only)
Up to six touch switches on the front layer and back layer of a screen can be superimposed.

Parts display A 
(Displays the part No.1 at rise of M10.)

Parts display B 
(Displays the part No.2 at rise of M20.)
Parts display C 
(Displays the part No.3 at rise of M30.)

 Three parts displays are 
superimposed and placed.

Parts display A is
displayed.

M10 = OFF → ON M20 = OFF → ON M30 = OFF → ON

Parts display B is 
displayed.

Parts display C is 
displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Superimpose window 1

Superimpose window 2

Base screen

Basic screen 
(Base screen)

Set overlay screen
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Setting two or more actions for a single touch switch
If switches are used, a set of actions arranged when two or more touch switches are superimposed can be 
imposed on a single touch switch.
For how to set touch switches, refer to the following.
➟8.2 Placing a Touch Switch

(b) Actions for superimposed touch switches, numerical inputs, and character string inputs
• Number of objects that have their actions enabled

Actions for up to six objects including superimposed touch switches, numerical inputs, and character string inputs 
are enabled by multiple placements, and if superimpose window 1 and 2 are displayed, actions for up to eight objects 
are enabled.
Actions for touch switches, numerical inputs, and character string inputs coming after eighth are not enabled.

• Key window actions in superimposition
Of two or more superimposed numerical inputs or character string inputs, only the first enabled numerical input or 
character string input opens the touch key window if [Display when touched] has been selected for the key window 
action in the [Key Window Advanced Setting] tab of the [Screen Property] dialog.
The other objects do not work.

• Actions of the overlapping key code switches
When different key codes are set for the overlapping key code switches, some of the switches may not function 
depending on the key code type.

(c) Order of priority according to the combination of superimposition
The following shows the order of priority given to actions for touch switches, numerical inputs, and character string inputs, 
according to the combination of superimposed windows.

Touch switches which are superimposed 
on the same screen (Up to six switches)

             Basic screen (Base screen)

Called screen (Base screen)

Multiple placements 
on the same screen

Base screen

Superimpose window 1, 2

9
8
7
6
5
4
3
2
1

Does not operate.

Actions of up to eight objects are 
performed by using the superimpose 
window 1 and 2.

Action order 
of objects

Number of objects that have 
their actions enabled
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• Order of actions for called screens
Actions for called screens are enabled in order of the set overlay screen function displaying the called screens.
For the display order with set overlay screen function, refer to the following.

➟8.29 Placing Another Screen on a Screen
• The number of called screens that can have the objects on them enabled

Superimposed objects including touch switches, numerical inputs, and character string inputs on a maximum of 99 
called screens are enabled.
If 100 or more screens have been called, the touch switches, numerical inputs, and character string inputs on the 
screens called after the hundredth do not work.

• Operation when the key window is displayed
When a numerical input object or a text input object calls the key window, the objects (touch switch, numerical input, 
and text input) behind this object and overlapping the key window do not operate.

(d) Application examples
The following shows enabled touch switches, numerical inputs, or character string inputs set on two or more screens.
The numbers 1 to 99 added to "Called window" indicate the order in which windows are called on base screens or window 
screens.

Called screen (1 to 99)
Front layer

Basic screenSuperimpose 
window 2  

Back layer
Basic screen

  

Front layer
Basic screen

Superimpose 
window 1  

Back layer
Basic screen

  

Front layer
Basic screen

Base screen 

Back layer
Basic screen

Touch

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

O
bj

ec
ts

 w
ho

se
 a

ct
io

ns
 a

re
 e

na
bl

ed

A
ct

io
n 

or
de

r o
f o
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ec

ts
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(5) Precautions

(a) Superimposing in the same layer the figures and objects that are always displayed in the topmost 
position in the layers.
If the following figures and objects are superimposed on the same layer, they may not be displayed normally depending 

2) 8)7)

8)

LayerScreen type

Front

Back

Front

Back

Front

Base screen

Back

Object which does not operate
Object which operates

1) to 8): Order of action to be enabled

Basic screen

Called screen 99

:

Called screen 5

Called screen 99

:

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

:

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

:

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

:

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

:

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Touch Touch Touch Touch Touch Touch

8) 8)

5)

6)

7)

6)

7)

4)

5)

3)

5)

6)

6)

4)

5)

6)

4)

5)

4)

3) 7) 1)

2)

3)

2)

3)

4)

1) 1) 7)

2) 5)

6)

1)

2)

3)

1)

2)

3)

4)

1)

Superimpose
window 1

Superimpose
window 2

7)

A
ct

io
n 

or
de

r
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on the settings made for them.
• Alarms: If [Display Type] is set to [Flow]
• Scatter graphs: If [Store Memory] is set
• Figures drawn by the free figure drawing function of the object scripts

To superimpose the objects of each type listed above, place them in the separate layers.

(b) Displaying objects with the XOR synthesis

• If neither figure nor object has been placed behind objects that have been placed in the front layer
If neither figure nor object has been placed behind the objects for the XOR synthesis, the objects integrate into the 
XOR synthesis with the transparent color of the front layer.

• Integrating into the XOR synthesis with figures
Place objects in the back layer.

(c) Superimposing objects with [Simultaneous Press] set for them
If keys with simultaneous presses disabled are superimposed, the keys do not work even if they are touched.

(d) Placing a PNG image

When you place a semi-transparent PNG image (with alpha channel) or an object using such an image as its shape on 
a layer, the semi-transparent area may appear differently depending on the layer.

• Front layer
The semi-transparent area displays the color specified for [Front Layer Transparent Color], appearing opaque.
To display the area transparent, place another image or figure between the PNG image or object and the front layer.

• Back layer
The semi-transparent area appears transparent.

For the semi-transparent PNG image file (with alpha channel), refer to the following.
➟7.13 (3) PNG file

■4 Setting data operations

If data operations are set for each object, set values of word devices are operated and monitored using the values after 
the operations.
Example) Using a data operation for a numerical display

• Monitored device: D101

(1) Specifications of the data operation

The data operation can be set for the following objects.
• Bit lamp
• Word lamp
• Numerical display
• Numerical input (only the logical AND operation is available for bit mask processing)
• Comment display
• Parts display
• Parts movement
• Historical data list display
• Line graph
• Trend graph

GOT Graphic Ver.1

GOT Graphic Ver.1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Rate of 
produced 
products

20%

Rate of produced products is displayed.

Operation of the 
calculation formula

D101 ÷ D100 × 100

D100
D101

Planned quantity of production
Quantity of produced products

5000
1000
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• Bar graph
• Statistics bar graph
• Statistics pie graph
• Scatter graph
• Historical trend graph
• Graphical meter
• Level object
• Panelmeter

(a) Bitwise operations
Data are operated and determined in bitwise operation.
The bitwise operation is the function that operates each bit of the value of a word device.

• Mask processing
Performs a logical operation on the value of a word device using a set pattern value.
· Logical AND
If the corresponding bits of a device value and a pattern value are both 1, the result is 1.
Otherwise the result is 0.
· Logical OR
If the corresponding bits of a device value and a pattern value are both 0, the result is 0.
Otherwise the result is 1.
· Exclusive OR
If the corresponding bits of a device value and a pattern value are equal, the result is 0, otherwise 1.
Example) When using the logical AND

• Shift processing
Operates the value of a word device shifting each bit to right or left.
If a device of a signed data type is monitored, an arithmetic sift operation is performed.
Example) Operation with right shift by 4 bits
· If signed data is monitored

· If unsigned data is monitored

• Data operation
Operates the value of a word device applying a data operating expression.
Select the format of the data operating expression from among nine types.
The following shows an example of the data operating expression.

Monitor 
device value

Pattern 
value 
(hexadecimal 
number)

Operation
result

AND

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

0 0 0 0 0 0 0 01 1 1 1 1 1 1 1

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

0 0 0

0 0

0 0 0 0

0 0

011 1 1 11 1 1

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

0 0 0 0 0 0 0 01 1 1 1

Monitor 
device value

Operation
result

Right-shift the 
values for 4 bits

1 00 1 0 01 1 0 00 1 1 01 1
b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

1 11 1 1 00 1 0 01 1 0 00 1
b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

Monitor 
device value

Operation
result

Right-shift the 
values for 4 bits

0 00 0 1 00 1 0 01 1 0 00 1
b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

1 00 1 0 01 1 0 00 1 1 01 1
b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0
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(b) Order of priority given to the operating processes
The following shows the order of priority given to the operating processes for device monitoring and numerical input

• When monitoring a device

• When using a numerical input
Writing the value after the operating process to a word device

Reading the value of a word device after the operating process

(2) How to use data operations

(a) Procedure for setting a data operation
The following shows the procedure for setting a data operation for an object.
For details of the setting items, refer to the setting dialog of each object.

Step 1 Place an object to the screen editor and display the setting dialog.
Step 2 Select [Data Operation] for [Operation Type] in the [Operation/Script] tab.
Step 3 Select the operation to be used from [Bit Mask], [Bit Shift], and [Data Operation].

When selecting [Data Operation], click the [Exp] button to display the [Edit Data Expression] dialog.
➟(3) [Edit Data Expression] dialog

Step 4 Click the [OK] button in the setting dialog to complete setting the operating processes.

(b) Order of priority given to two or more set operating processes in numerical input, and the operations 
to be performed.
The following shows the order of priority given to operating processes in writing to and reading from a word device with 
a numerical input, and the operations to be performed.
In writing and reading, the numbers in ascending order corresponds to the order of decreasing precedence.

• Writing the value after the operating processes to the word device: Step 1 to 3
• Reading the value of the word device after the operating processes: Step 4 to 6

Priority Operating process

High
↓
Low

Mask processing

Shift processing

Data operation

Priority Operating process

High
↓
Low

Data operation

Shift processing

Mask processing

Priority Operating process

High
↓
Low

Mask processing

Shift processing

Data operation

Set the value to process operation to $$ and $W.

Constant: The value which is directly set by users. 
                 Up to 32 digits of values including minus or the decimal point can be set.
 Variable: Word device which is set for the operation of the data operation function

Operator
* (multiplication), / (division), + (addition), - (subtraction), % (remainder)

$$: Values of devices that the objects monitor 
$W: Input value of the numerical input

$$($W) D10*

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 1 Data operation
Operates the input value in the operating expression for the write operation on the device value.

Step 2 Shift processing
Sifts the bits of the input value to the set direction.

Step 3 Mask processing (AND)
Puts the input value through the mask processing with a set pattern value.
Performs the following operation so that the value is written with the bits on which mask processing was 
executed removed.
(Written value) = ((Input value) AND (Pattern value)) OR ((Current value) AND (Reverse pattern value))
Example) Overwriting the rightmost 2 bits of the current value ABCDh with 12h

• Input value (value the user inputted): 0012h
• Current value (value before overwriting): ABCDh
• Pattern value (value the user set): 00FFh
• Reverse pattern value (value the GOT creates for operation)

Step 4 Mask processing
Puts the device value through the mask processing with a set pattern value.

Step 5 Shift processing
Sifts the bits of the device value to the direction opposite to that in writing.

Step 6 Data operation
Operates the written value in the operating expression for the read operation on the device value, and 
displays it.

1. 2. 3.

4.5.6.

Mask 
processing

(AND)

Mask 
processing

(AND)

Data 
operation

Data 
operation

12345

Shift 
processing

Shift 
processing

Input numerical values.

The value after the data operation 
processing is displayed.

(Input value) AND (Pattern value)

{(Input value) AND (Pattern value)} OR

OR

Write value

AB12h

(Current value) AND (Reverse pattern value)

{(Current value) AND (Reverse pattern value)}

0012h  AND  00FFh

0012h

ABCDh  AND  FF00h

AB00h

0012h AB00h
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(3) [Edit Data Expression] dialog

Displayed when the [Exp] button in [Data Expression] is clicked.
Depending on the type of the object, the setting items in the setting dialog differ.
Refer to the setting items explained in this section that are provided for the object to be used.

1) Operating expression
Displays a set operating expression.

2) [Style]
Select the format of the expression.

The following shows the items to be selected.
• [None]
• [A.B]
• [A.(B.C)]
• [(A.B).C]
• [A.((B.C).D)]
• [A.(B.(C.D))]
• [((A.B).C).(D.E)]
• [(A.B).((C.D).E)]
• [((A.B).(C.D)).E]

3) Operators
Select operators to be used in the operating expression.
The following shows the items to be selected.

• [+]: Addition
• [-]: Subtraction
• [*]: Multiplication
• [/]: Division
• [%]: Remainder

If [%] is selected, the left side is divided by the right side, and the operation result is the remainder.
Example) 100 % 3 = 1(100 ÷ 3 = 33 and the remainder is 1)

4) [Constant Data Type]
Select the data type if [Constant] has been selected for [Term Type] of the range expressing setting.
The following shows the items to be selected.

• [Hex]
• [Dec]
• [Oct]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

5)

3)
4)

A . (B . C)
Constant, variable ($$, $W, other devices)
Operator
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5) Range expression setting

Item Description

[Term Type]

Select the type and value of each side (A to E) of the range expression.
The following shows the items to be selected.
• [Constant]:

Operates with constants.
• [$$], [$W]:

Operates the value of the target word device for monitoring or writing.
Set this item in the range expression as it is compulsory.

• [Other Device]:
Operates the value of a word device.
The data type is the same as the device to be monitored ([$$], [$W]).

[Value]

Select the value of each side (A to E) of the range expression.
Depending on the [Term Type], the setting item differs.
• When [Constant] is selected: Set a numerical value.
• When [$$] or [$W] is selected: The target device for monitoring is displayed.
• When [Other Device] is selected: Set a device.
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6.6 Editing Operations

➟6.6.1 [Undo], [Redo]
6.6.2 [Cut], [Copy], [Paste]
6.6.3 [Duplicate]
6.6.4 [Consecutive Copy]
6.6.5 [Select All]
6.6.6 [Delete]
6.6.7 [Object of Selection]
6.6.8 [Group], [Ungroup]
6.6.9 [Stacking Order]
6.6.10 [Align]
6.6.11 [Rotate/Flip]
6.6.12 [Edit Vertices]
6.6.13 [Edit Objects with Fixed Frame Width]
6.6.14 [Edit Touch Area]
6.6.15 [Adjust Direct Text Size]
6.6.16 [Template Registration]
6.6.17 [Edit Template Attribute]
6.6.18 [Set to Default]
6.6.19 [Add to Category]
6.6.20 [Shape Change]
6.6.21 [Display Template Property]
6.6.22 [Setting]
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6.6.1 [Undo], [Redo]

[Undo] and [Redo] are available only on the screen editors and the data view.

■1 [Undo]
Cancels the last operation.

Step 1 Select [Edit] → [Undo] from the menu.
Step 2 The last operation is canceled.

■2 [Redo]
Redoes the operation canceled by [Undo].

Step 1 Select [Edit] → [Redo] from the menu.
Step 2 The operation canceled by [Undo] is redone.

■3 Operation histories of [Undo] and [Redo]
(1) Number of storable operations

There is no limit to the number of storable operations to the operation histories.

(2) Unit of the operation histories
The operation history is held per screen.
Therefore, when creating multiple screens, display a screen to which you want to redo operations and perform [Undo] or 
[Redo].

(3) Timing when the operation history is deleted
The operation histories of [Undo] and [Redo] are deleted at the following timing.

(a) Deletion of the operation histories of both [Undo] and [Redo]
• Closing a project
• Deleting or cutting the target screen
• Pasting a copied or cut screen to a selected area
• Changing the controller type
• Executing the [Collective Edit] command on the [Edit Objects with Fixed Frame Width] submenu
• Changing the GOT type

(b) Deletion of the operation history of [Redo] only
• Performing other editing operations (such as placing an object) when [Redo] is available

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.6.2 [Cut], [Copy], [Paste]

You can cut or copy a selected target and paste it onto an arbitrary area.
You can cut, copy, and paste the following targets.

• [Cut], [Copy]
Select a target from the placed or set data (including figures, objects, and windows) in a screen editor, the [Screen] 
window, or the [Project] window.

• [Paste]
Select an area where the cut or copied target is pasted in a screen editor, the [Screen] window, or the [Project] 
window.

■1 [Cut]
Cuts a selected target.

Step 1 Select a target data.
Step 2 Select [Edit] → [Cut] from the menu.
Step 3 The selected target is cut.

■2 [Copy]
Copies a selected target.

Step 1 Select a target data.
Step 2 Select [Edit] → [Copy] from the menu.
Step 3 The selected target is copied.

■3 [Paste]
Pastes the cut or copied data.

Step 1 Cut or copy a target data.
Step 2 Select [Edit] → [Paste] from the menu.
Step 3 The cut or copied data is pasted onto an arbitrary area.

■4 Holding the cut or copied data
The cut or copied data is overwritten when a new data is cut or copied.
The last cut or copied data is deleted at the following timing.

• When a figure, an object, or an image file is cut or copied
The data is deleted when the project where the cut or copied target is used is closed.

• When character strings or data on the data browser are cut or copied
The data is deleted when another target is cut or copied.

■5 Precautions
(1) Pasting a target from other projects

If the controller settings differ between in the copy source project and the copy destination project, the set devices may 
be displayed as [??].
Check if the pasted device has no problem and set the device again as required.

(2) Cutting, copying, and pasting data between projects created by GT Designer3(GOT2000) and GT 
Designer3(GOT1000)
Cutting, copying, and pasting data between projects created by GT Designer3(GOT2000) and GT Designer3(GOT1000) 
are unavailable.
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6.6.3 [Duplicate]

Copies and pastes a selected figure or object at a time.
Select a figure or an object placed on the screen editor and use [Duplicate].

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Duplicate] from the menu.
Step 3 The selected figure or object is copied and pasted with a certain interval.

■1 Intervals between the pasted targets
You cannot change the intervals for pasting figures or objects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.6.4 [Consecutive Copy]

Copies and pastes a selected figure or object at a time based on the settings.
Select a figure or an object placed on the screen editor and use [Consecutive Copy].

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Consecutive Copy] from the menu to display the [Consecutive Copy] dialog.
Step 3 Configure the settings and click the [OK] button. The figure or object is pasted based on the settings.

■1 [Consecutive Copy] dialog

1) [Total count after copy]
Set the number of figures or objects to be pasted.

• [X]:
Set the number of figures or objects to be horizontally pasted.
The setting range is [1] to [100].

• [Y]:
Set the number of figures or objects to be vertically pasted.
The setting range is [1] to [100].

Example) When the following settings are configured
[X]: [3]
[Y]: [2]
[Copy Direction]: 

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
4)

5)
6)

7)

8)
10)

9)
11)

Copy source X: 3

Y: 2
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2) [Interval]
Set an interval between figures or objects to be pasted.
The following shows the items to be selected.

• [Interval]
• [+Figure/Object]

The setting ranges of [X] and [Y] differ depending on the selected item.

3) [Copy Range]
Set an area where figures or objects can be pasted.
The following shows the items to be selected.

• [Screen + Temporary area]
• [Screen]

Item Description

When [Interval] is selected

The following shows the setting range.
• [X]:

Set an interval between figures or objects to be horizontally pasted.
The setting range is [0] to [300].

• [Y]:
Set an interval between figures or objects to be vertically pasted.
The setting range is [0] to [300].

Example) When the following settings are configured
[X]: [5]
[Y]: [3]
[Copy Direction]: 

When [+ Figure/Object] is 
selected

The following shows the setting range.
• [X]:

Set an interval between figures or objects to be horizontally pasted.
The setting range is [0] to [300 + Horizontal size of the copy source figure or object (dots)].

• [Y]:
Set an interval between figures or objects to be vertically pasted.
The setting range is [0 + Vertical size of the copy source figure or object (dots)] to [300 + Vertical size 
of the copy source figure or object (dots)].

Example) When the following settings are configured
[X]: [10]
[Y]: [15]
[Copy Direction]: 

For one figure

For multiple figures
5 

do
ts

5 
do

ts

3 dots

3 dots

15 dots

15 dots

10 dots

For one figure

For multiple figures

10 dots
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4) [Copy Direction]
Set a direction in which figures or objects are pasted.
The following shows the items to be selected.

5) [Device No.]
Select this item to increment the device number of the device set for a figure or object.
Labels and tags do not support the increment of device numbers.
The label of the source figure or object is set for the figures or objects pasted using the consecutive copy function.

6) [Target Device]
Set the target devices whose device numbers are to be incremented.
The following shows the items to be selected.

• [Monitor/Lamp Device]
• [All]

7) [Increment Setting]
Select whether to collectively or individually set the increment count of the device numbers of multiple devices set 
for a figure or object to be copied.
The following shows the items to be selected.

• [All]
Set the increment count collectively.
The setting range is [-10000] to [10000].

• [Individual]
Set the increment count individually.
The setting range is [-10000] to [10000].

8) [Comment Group No.]
Select this item to increment the comment group number set for an object.
The setting range of the increment count is [-100] to [100].

9) [Comment No.]
Select this item to increment the comment number set for an object.
The setting range is [-10000] to [10000].
When an object whose comment number is set to 0 is copied, the comment number is not incremented.

10) [User ID]
Select this item to increment the user ID set for an object.
The setting range is [-10000] to [10000].

11) [Move Destination ID]
Select this item to increment the move destination ID set for an object.
The setting range is [-10000] to [10000].

· · · ·

· · · ·
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6.6.5 [Select All]

Selects all the data placed or set on the selected screen editor or window.
Select a screen editor, the [Comment List] window, or other screens and use [Select All].

Step 1 Select a screen editor or a window on which the data you want to select is placed or set.
Step 2 Select [Edit] → [Select All] from the menu.
Step 3 All the targets that are placed or set on the screen editor or the window are selected.

6.6.6 [Delete]

Deletes a selected target.
Select a target data from the placed or set data in a screen editor, the [Screen] window, or the [Project] window and use 
[Delete].

Step 1 Select a target data.
Step 2 Select [Edit] → [Delete] from the menu.
Step 3 The selected target is deleted.

6.6.7 [Object of Selection]

Set the targets to be selected on a screen editor.
Select a screen editor or other screens and use [Object of Selection].
The settings are reflected to the whole project.

■1 [Figure]
Set this item to select only figures from figures and objects placed on the screen editor.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Object of Selection] → [Figure] from the menu.
Step 3 You can select only figures on the screen editor.

■2 [Object]
Set this item to select only objects from figures and objects placed on the screen editor.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Object of Selection] → [Object] from the menu.
Step 3 You can select only objects on the screen editor.

■3 [Figure + Object]
Set this item to select both figures and objects placed on the screen editor.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Object of Selection] → [Figure + Object] from the menu.
Step 3 You can select figures and objects on the screen editor.

■4 [Report Line]
Set this item to select lines on the screen editor of the report screen.

Step 1 Select the screen editor of the report screen.
Step 2 Select [Edit] → [Object of Selection] → [Report Line] from the menu.
Step 3 You can select lines on the screen editor of the report screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■5 [Overlay Screen]
Set this item to select called screens placed on the screen editor.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Object of Selection] → [Overlay Screen] from the menu.
Step 3 You can select called screens on the screen editor.

■6 Precautions
(1) Placing figures, objects, or called screens

You can newly place a figure, an object, or a called screen regardless of the selection of [Object of Selection].
When the figure, object, or called screen that was newly placed is out of the selection target, the setting of [Object of 
Selection] is changed to include it to the selection target.
Example) When [Figure] is selected for [Object of Selection] and an object is placed
The setting of [Object of Selection] is changed to [Figure + Object].

(2) Selecting grouped figures or objects
You can select grouped figures or objects when the selected target is included in the group.
Example) When [Figure] is selected for [Object of Selection]

• A group that includes figures only: Selectable
• A group that includes figures and objects: Selectable
• A group that includes objects only: Unselectable

(3) Selecting figures and objects in the [Data View] window
You can select only the target data selected in [Object of Selection].

6.6.8 [Group], [Ungroup]

Groups multiple figures and objects into one.
Groups are treated as figures.
You can group and ungroup the following targets.

• [Group]
Select multiple figures and objects placed on the screen editor.
For the grouping of the template information, figures and objects that are registered to the template, refer to the 
following.

➟11.6 Efficient Drawing with Templates
• [Ungroup]

Select a group that is placed on the screen editor.

■1 [Group]
Groups the selected figures and objects into one.

Step 1 Select multiple figures or objects.
Step 2 Select [Edit] → [Group] → [Group] from the menu.
Step 3 The selected figures or objects are grouped.
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■2 [Ungroup]
Cancels the grouping of a selected group.

Step 1 Select a group.
Step 2 Select [Edit] → [Group] → [Ungroup] from the menu.
Step 3 The grouping of the selected group is canceled.

■3 Editing grouped figures and objects
You can individually select and edit grouped figures and objects without ungrouping them.
For a grouping of multiple groups of figures and objects, you can also select and edit each figure or object in the grouping 
by using the same procedure.

Step 1 Select a group.
Step 2 Select a figure or object to be edited in the group.

Step 3 Double-click the selected figure or object to display the setting dialog.

(1) Editing or operating each figure or object
When editing or operating grouped figures or objects individually, you cannot perform the following operations.

• Moving a figure or object
• Resizing a figure or object
• Resizing the touch area of a figure or object
• Deleting a figure or object

■4 Precautions
(1) Setting in the property sheet

You can change the set items common to all the figures and objects in the group in the property sheet.
The changed setting is reflected to all the figures and objects in the group.
In the property sheet, you cannot change the setting of a figure or object in a group.
To change the setting of a figure or object in a group, display the corresponding setting dialog and make changes.

(2) Changing the coordinates
When you select a grouping of figures or objects, the [Coordinate/Size] toolbar and the [Property] window display the 
coordinates of the upper-left corner of the grouping.
If you change the coordinates, the figures and objects in the grouping move accordingly while their intervals remain 
unchanged.
For information on how to change the coordinates, refer to the following.

➟2.2.2 ■15 [Coordinate/Size]
11.9.4 [Property] window

(3) Changing the size (width and height)
When you select a grouping of figures and objects, the [Coordinate/Size] toolbar and the [Property] window display the 
width and height of the grouping. The width and height are not changeable in the above toolbar and window.
To change the size of the grouping, use the size change handle on the screen editor.
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6.6.9 [Stacking Order]

Changes the display order of figures and objects.
Select a figure or an object placed on the screen editor and use [Stacking Order].
For the layers, refer to the following.

➟6.5.5 ■3 Superimposition

■1 [Move to the Front of Front Layer]

Moves the selected figure or object to the topmost position on the front layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Front of Front Layer] from the menu.
Step 3 The selected figure or object is moved to the topmost position on the front layer.

■2 [Move to the Back of Back Layer]

Moves the selected figure or object to the back on the back layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Back of Back Layer] from the menu.
Step 3 The selected figure or object is moved to the back on the back layer.

■3 [Move to the Front of Layer]

Moves the selected figure or object to the topmost position on the same layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Front of Layer] from the menu.
Step 3 The selected figure or object is moved to the topmost position on the same layer.

■4 [Move to the Back of Layer]

Moves the selected figure or object to the back position on the same layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Back of Layer] from the menu.
Step 3 The selected figure or object is moved to the back on the same layer.

■5 [Move to the Foreground]

Moves the selected figure or object to the topmost position.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Foreground] from the menu.
Step 3 The selected figure or object is moved to the topmost position.
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■6 [Move to the Background]

Moves the selected figure or object to the back.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Background] from the menu.
Step 3 The selected figure or object is moved to the back.

■7 [Move to the Front]

Moves the selected figure or object to the front of the figure or object on the selected one in the same layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Front] from the menu.
Step 3 The selected figure or object is moved to the front of the figure or object on the selected one in the same 

layer.

■8 [Move to the Back]

Moves the selected figure or object to the back of the figure or object behind the selected one in the same layer.
Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Stacking Order] → [Move to the Back] from the menu.
Step 3 The selected figure or object is moved to the back of the figure or object behind the selected one in the same 

layer.
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6.6.10 [Align]

Aligns multiple figures and objects.
Select multiple figures and objects that are placed on the screen editor and use [Align].
The alignment behavior differs according to whether a figure or object is anchored among selected figures and objects.

If you anchor a selected figure or object, the selected figures and objects are aligned to the anchored figure or object 
according to the specified alignment type.
(The anchored figure or object is framed in red.)
Example) When the left alignment is performed while a lamp object is anchored

If you do not anchor a selected figure or object, the selected figures and objects are aligned according to the specified 
alignment type.
Example) When the left alignment is performed while no figure or object is anchored

■1 [Left]
Aligns the selected figures and objects to the left.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Left] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the left edge of the 
anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned to the left edge 
of the leftmost-selected figure or object.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Anchored object

The selected figure and objects 
are aligned to the left edge of 
the anchored object.

The selected figure and objects are aligned to 
the left edge of the leftmost-selected object.
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■2 [Center (Horizontal)]
Horizontally centers the selected figures and objects.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Center (Horizontal)] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the center of the 
anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned through their 
centers.

■3 [Right]
Aligns the selected figures and objects to the right.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Right] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the right edge of the 
anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned to the right edge 
of the rightmost-selected figure or object.

■4 [Top]
Aligns the selected figures and objects to the top.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Top] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the top edge of the 
anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned to the top edge 
of the highest-selected figure or object.
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■5 [Center (Vertical)]
Vertically centers the selected figures and objects.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Center (Vertical)] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the center of the 
anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned through their 
centers.

■6 [Bottom]
Aligns the selected figures and objects to the bottom.

Step 1 Select figures and objects to be aligned.
Step 2 Select a figure or object to be anchored from among those already selected as necessary.

The anchored figure or object is framed in red.
Step 3 Select [Edit] → [Align] → [Bottom] from the menu.

If you have an anchored figure or object, the selected figures and objects are aligned to the bottom edge of 
the anchored figure or object.
If you do not have an anchored figure or object, the selected figures and objects are aligned to the bottom 
edge of the lowest-selected figure or object.

■7 [Align Sideways]
Aligns the selected figures and objects so that they are equally spaced horizontally.

Step 1 Select figures and objects to be aligned.
Step 2 Select [Edit] → [Align] → [Align Sideways] from the menu.

The selected figures and objects are equally spaced horizontally between the following points (reference 
points).
• Upper-left corner of the leftmost-selected figure or object
• Upper-left corner of the rightmost-selected figure or object
(Anchoring of a selected figure or object is invalid.)

Reference points The figures and objects are 
equally spaced between 
the reference points.
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■8 [Align Lengthways]
Aligns the selected figures and objects so that they are equally spaced vertically.

Step 1 Select figures and objects to be aligned.
Step 2 Select [Edit] → [Align] → [Align Lengthways] from the menu.

The selected figures and objects are equally spaced vertically between the following points (reference 
points).

• Upper-left corner of the highest-selected figure or object
• Upper-left corner of the lowest-selected figure or object

(Anchoring of a selected figure or object is invalid.)

■9 [Custom]
Aligns the selected figures and objects with multiple conditions.

Step 1 Select multiple figures and objects.
Step 2 Select [Edit] → [Align] → [Custom] from the menu to display the [Align] dialog.
Step 3 Configure the alignment settings and click the [OK] button to align the figures and objects.

(1) [Align] dialog

1) Preview
Previews the alignment of the figures and objects.

2) [Align equally]
Aligns figures and objects evenly and horizontally or vertically.

• [Horizontal]: Evenly and horizontally aligns figures and objects.
• [Vertical]: Evenly and vertically aligns figures and objects.

3) Horizontal alignment
Set the base position for evenly and horizontally aligning figures and objects.

4) Vertical alignment
Set the base position for evenly and vertically aligning figures and objects.

Reference
points

The figures and objects 
are equally spaced 
between the reference points.

Item Description

[None] button Does not align figures and objects.

[Left] button Aligns figures and objects to the left.

[Center] button Aligns figures and objects to the center.

[Right] button Aligns figures and objects to the right.

Item Description

[None] button Does not align figures and objects.

[Top] button Aligns figures or objects to the top.

[Center] button Aligns figures and objects to the center.

[Bottom] button Aligns figures or objects to the bottom.

1)

3)

2)

4)

5)
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5) [Apply] button
Reflects the settings to the figures and objects on the screen editor.

6.6.11 [Rotate/Flip]

Rotates or flips a selected figure.
Select a figure placed on the screen editor and use [Rotate/Flip].

■1 [Flip Vertical]
Flips a selected figure vertically.

Step 1 Select a figure.
Step 2 Select [Edit] → [Rotate/Flip] → [Flip Vertical] from the menu.
Step 3 The selected figure is flipped vertically.

■2 [Flip Horizontal]
Flips a selected figure horizontally.

Step 1 Select a figure.
Step 2 Select [Edit] → [Rotate/Flip] → [Flip Horizontal] from the menu.
Step 3 The selected figure is flipped horizontally.

■3 [Rotate Left]
Rotates a selected figure 90 degrees counterclockwise.

Step 1 Select a figure.
Step 2 Select [Edit] → [Rotate/Flip] → [Rotate Left] from the menu.
Step 3 The selected figure is rotated 90 degrees counterclockwise.

■4 [Rotate Right]
Rotates a selected figure 90 decrees clockwise.

Step 1 Select a figure.
Step 2 Select [Edit] → [Rotate/Flip] → [Rotate Right] from the menu.
Step 3 The selected figure is rotated 90 degrees clockwise.

■5 Precautions
(1) Rotating or flipping a group

A group is rotated or flipped as one figure.

(2) Figures which cannot be rotated
If a figure after the rotation does not fit in the screen display area or the temporary area, the figure cannot be rotated.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
6 - 190 6. BASIS OF SETTING AND EDITING
6.6 Editing Operations



6

B
A

SI
S 

O
F 

SE
TT

IN
G

 A
N

D
 E

D
IT

IN
G

6.6.12 [Edit Vertices]

Switches the handle of a selected figure to the size change handle or the vertex edit handle.
➟6.5.3 Editing figures and objects

Select a screen editor or others and use [Edit Vertices].
Step 1 Select a screen editor.
Step 2 Select [Edit] → [Edit Vertices] from the menu to switch the handle to the size change handle or the vertex 

edit handle.

■1 Editing a figure with the vertex edit handle
(1) Figures that can be edited with the vertex edit handle

The following shows the figures whose handles are changed when [Edit] → [Edit Vertices] is selected from the menu.
• [Line Freeform]
• [Piping]
• [Polygon]

(2) Operation example of the vertex edit handle
The following shows the operation example for editing a freeform line with the vertex edit handle.

Step 1 Select a figure.
Step 2 Drag the handle to change the vertex position.
Step 3 Release the mouse button to determine the change of the vertex position of the figure.

■2 Precautions
(1) Editing vertexes of grouped figures

Editing vertexes of grouped figures is unavailable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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6.6.13 [Edit Objects with Fixed Frame Width]

Fixes or does not fix the frame width of the object shape when the object is resized.
When the frame width fixing setting is enabled, resizing an object does not change the frame width.
This setting is effective on the entire project.

Example) When an object is enlarged

The frame width fixing setting is applied when the following conditions are satisfied.

■1 [Always Fix the Width]
Fixes or does not fix the shape frame width.

Step 1 Select [Edit] → [Edit Objects with Fixed Frame Width] → [Always Fix the Width] from the menu.
Step 2 The frame width is fixed or not fixed.

■2 [Collective Edit]
Changes the shape frame widths of all objects that satisfy the frame width fixing conditions.
After the change, the frame widths become fixed.
For the frame width fixing conditions, refer to the following.

➟6.6.13 [Edit Objects with Fixed Frame Width]
Step 1 Select [Edit] → [Edit Objects with Fixed Frame Width] → [Collective Edit] from the menu.
Step 2 The shape frame widths of all applicable objects are changed.

After the change, the frame widths become fixed.

Condition Details

The frame width fixing setting must be enabled.
The frame width fixing setting is enabled by default.
This setting is disabled when you open a project created with GT Designer3 version earlier than 
1.175H.

The resize target object must be one to which the 
frame width fixing setting is applicable.

For the applicable objects, refer to the following.

➟■3 Objects to which the frame width fixing setting is applicable

The target object shape must be one to which the 
frame width fixing setting is applicable.

The applicable shapes are included in the system library.
For each shape, check the [Library data Property] dialog for applicability.
If [Shape] is any other than [None], the frame width fixing setting is applicable to the shape.

➟8.1.4 [Library] window
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When the frame width fixing setting 
is enabled

When the frame width fixing setting 
is disabled
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■3 Objects to which the frame width fixing setting is applicable
The following shows the objects to which the frame width fixing setting is applicable.
○: Applicable, ×: Not applicable

Object Applicability Remarks

Touch Switch

Switch ○ -

Bit Switch ○ -

Word Switch ○ -

Go To Screen Switch ○ -

Change Station No. Switch ○ -

Special Function Switch ○ -

Key window display switch ○ -

Key Code Switch ○ -

Lamp

Bit Lamp ○ -

Word Lamp ○ -

Lamp Area × No shape setting.

Numerical Display/Input
Numerical Display ○ -

Numerical input ○ -

Text Display/Input
Text Display ○ -

Text Input ○ -

Date/Time Display
Date Display ○ -

Time Display ○ -

Comment Display

Bit Comment ○ -

Word Comment ○ -

Simple Comment × No shape setting.

Parts Display

Bit Parts × No shape setting.

Word Parts × No shape setting.

Fixed Parts × No shape setting.

Parts Movement

Bit Parts × No shape setting.

Word Parts × No shape setting.

Fixed Parts × No shape setting.

Parts Move Route × No shape setting.

Historical Data List Display ○ -

Alarm Display

Alarm Display (User) ○ -

Alarm Display (System) ○ -

Simple Alarm Display ○ -

System Alarm Display ○ -

Recipe Display (Record List) ○ -

Graph

Line Graph ○ -

Trend Graph ○ -

Bar Graph ○ -

Statistics Bar Graph ○ -

Statistics Pie Graph ○ -

Scatter Graph ○ -

Historical Trend Graph ○ -

Graphical Meter ○ The shape frame width is always fixed regardless of the frame 
width fixing setting.

Meter
Level × No shape setting.

Panelmeter × -
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■4 Precautions
(1) Reducing an object

Even when the frame width fixing setting is enabled, if you reduce the object size (width or height) to less than its shape 
frame width, the frame width is reduced as well.

Slider × -

Document Display × No shape setting.

Video/RGB display object × No shape setting.

Script parts × No shape setting.

Set Overlay Screen × No shape setting.

Window Position × No shape setting.

Key Window Object

Input Value Area Setting × No shape setting.

Input Range Area Setting × No shape setting.

Input Maximum Value Area 
Setting × No shape setting.

Input Minimum Value Area Setting × No shape setting.

Previous Value Area Setting × No shape setting.

Print

Numerical Print × No shape setting.

Text Print × No shape setting.

Bit Comment Print × No shape setting.

Word Comment Print × No shape setting.

Hyperlink ○ -

Object Applicability Remarks
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6.6.14 [Edit Touch Area]

Select the editing method of the touch area.
You can perform [Manual Edit], [Self-adjust], and [Constant Self-adjust] to the following targets.

• [Manual Edit], [Constant Self-adjust]
Select a screen editor or others.

• [Self-adjust]
Select a touch switch placed on the screen editor.

When [Adjust the touch area to be smaller than its object size by 1-dot at the time of touch area self-adjust] is selected 
on the [Edit] tab in the [Options] dialog, the touch area is reduced to be inside the object area. The edge of the touch area 
becomes 1 dot away from the edge of the object area.

➟11.10.4 Customizing the settings related to editing operations
This setting helps prevent unintended touches when objects are adjacent to each other.

■1 [Manual Edit]
Allows you to edit the touch area manually.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Edit Touch Area] → [Manual Edit] from the menu.
Step 3 You can edit the touch area manually.

■2 [Self-adjust]
Adjusts the size of the touch area automatically according to the object size.
When [Constant Self-adjust] is set, this setting is unavailable.

Step 1 Select a touch switch.
Step 2 Select [Edit] → [Edit Touch Area] → [Self-adjust] from the menu.
Step 3 The size of the touch area of the selected touch switch is adjusted automatically.
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Touch area

When the setting is enabled When the setting is disabled

Touch area
(the same size as the object)

Enabling the setting helps prevent 
unintended touches when objects are 
adjacent to each other.
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■3 [Constant Self-adjust]
Always adjusts the size of the touch area automatically according to the object size.

Step 1 Select a screen editor.
Step 2 Select [Edit] → [Edit Touch Area] → [Constant Self-adjust] from the menu.
Step 3 The touch areas of placed touch switches and newly placed touch switches are always adjusted 

automatically.

6.6.15 [Adjust Direct Text Size]

Scales the size of the direct input text according to the object size.
➟6.5.3 Editing figures and objects

Select a screen editor or others and use [Adjust Direct Text Size].
Step 1 Select a screen editor.
Step 2 Select [Edit] → [Adjust Direct Text Size] from the menu.
Step 3 When [Adjust Direct Text Size] is active, text size is changed by scaling the object size and when not active, 

not changed.

■1 Precautions
(1) Maximum and minimum sizes of texts

When the objects are scaled beyond the maximum or minimum size of texts, the texts hold the maximum or minimum 
size.
Objects can be scaled regardless of the maximum or minimum size of the texts.
Example 1) Enlarging an object beyond the maximum size of the texts
The texts hold the maximum size. Only the object size is enlarged.

Example 2) Reducing the object size beyond the minimum size of the texts
The texts hold the minimum size. Only the object size is reduced.
When the object size is reduced beyond the minimum size of the texts, the texts are displayed beyond the object.
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6.6.16 [Template Registration]

Registers a selected figure or object to the template or deletes the registration of a figure or an object from the template.
For figures and objects that can be registered to the template, refer to the following.

➟11.6 Efficient Drawing with Templates
You can perform [Register to Template] or [Deregister from Template] to the following targets.

• [Register to Template]
Select a figure or an object placed on the screen editor.

• [Deregister from Template]
Select a figure or an object that is registered to the template and placed on the screen editor.

■1 [Register to Template]
Registers a selected figure or object to the template.

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Template Registration] → [Register to Template] from the menu to display the setting dialog.

For how to set the setting dialog, refer to the following.
➟11.6 Efficient Drawing with Templates

■2 [Deregister from Template]
Deletes the registration of a selected figure or object from the template.

Step 1 Select a figure of object that is registered to the template.
Step 2 Select [Edit] → [Template Registration] → [Deregister from Template] from the menu.
Step 3 The selected figure or object is deleted from the template.

6.6.17 [Edit Template Attribute]

Displays the setting dialog to edit a template attribute.
Select a figure, an object, and a template information box placed on the screen editor and use [Edit Template Attribute].

Step 1 Select a figure, an object, or a template information box.
Step 2 Select [Edit] → [Edit Template Attribute] from the menu to display the setting dialog.

For how to set the setting dialog, refer to the following.
➟11.6 Efficient Drawing with Templates

6.6.18 [Set to Default]

Configures the settings of a selected figure or an object as the default values.
For the default values, refer to the following.

➟11.10.6 Customizing the default value
Select a figure or an object placed on the screen editor and use [Set to Default].

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Set to Default] from the menu to configure the settings of the selected figure or object as the 

default value.
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6.6.19 [Add to Category]

Sets a category of a selected figure or an object.
For the categories, refer to the following.

➟11.7 Managing figures and objects by category
Select a figure or an object placed on the screen editor and use [Add to Category].

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Add to Category] from the menu.
Step 3 Select an item to be set for [Category] of the selected figure or an object from the following.

• [Switch]
• [Lamp]
• [Other]
• [User-defined Category]

Step 4 When you select [User-defined Category], the [Category] dialog is displayed.
In the [Category] dialog, you can select the user-created categories as well as [Switch], [Lamp], and [Other].
For how to create a category, refer to the following.

➟11.7.4 [Category List] window
Step 5 The selected content is set to [Category] of the selected figure or object.

6.6.20 [Shape Change]

Set the shape of a selected object.
Select an object that is placed on the screen editor to which a shape can be set and use [Shape Change].

Step 1 Select an object.
Step 2 Select [Edit] → [Shape Change] from the menu to display the [Image List] dialog.

For how to configure the settings in the [Image List] dialog, refer to the following.
➟6.5.5 ■1 Setting object shapes

■1 Precautions
(1) Setting shapes of multiple objects

When multiple objects are selected and if the settings of shapes of each object are different, [Shape Change] is not 
available.

6.6.21 [Display Template Property]

Displays the settings of the template.
For how to set the [Property] window, refer to the following.

➟11.6 Efficient Drawing with Templates
Select a figure, an object, or a template information box placed on the screen editor and use [Display Template Property].

Step 1 Select a figure, an object, or a template information box.
Step 2 Select [Edit] → [Display Template Property] from the menu to display the [Property] window.
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6.6.22 [Setting]

Displays the setting dialog of a selected figure or an object.
Select a figure or an object placed on the screen editor and use [Setting].

Step 1 Select a figure or an object.
Step 2 Select [Edit] → [Setting] from the menu to display the setting dialog of the selected figure or object.

■1 Operation target
Select a figure or an object placed on the screen editor.
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7.1 Drawing a Text

Draw a text.

■1 How to draw
Step 1 Select [Figure]→[Text] from the menu.
Step 2 Place the cursor on the position where you draw the text, and click on it.

The [Text] dialog appears.
Step 3 Configure the settings in the [Text] dialog.

➟7.1.1 [Text] dialog
Step 4 After the setting, click the [OK] button.

The text is placed.

■2 Similar functions
The following shows other functions which enables the text to be displayed on the GOT screen.

(1) [Logo Text]
Draws the text with outline or gradation.
The logo text is effective to make the text highly visible.

➟7.2 Drawing a Logo Text
The logo text can be converted from the text in the [Text] dialog.

(2) [Text Display]
Uses the values stored in the word device as the text code to display the text on the object.

➟8.5 Placing a Text Display and Text Input

(3) [Comment Display]
Displays the text registered in the project on the object.
The comment display is used to display the same text on multiple objects or to display the messages corresponding to 
the device values.

➟5.8 Comment Setting ([Comment])
8.7 Placing a Comment Display

7.1.1 [Text] dialog

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4, 5)

6)
7)
9)

10)

13)
14)

2)
3)

15)

8)

11)
12)
7 - 2 7. FIGURES
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1) [Text]
Set the text to be displayed.
The input text is displayed on the screen.

Up to 512 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of characters.)

2) [Convert to Logo Text] button
Converts the text to the logo text.
The [Text] dialog changes to the [Logo Text] dialog.

➟7.2.1 [Logo Text] dialog
3) [Convert to Comment Display] button

Registers text to a comment group and converts the text figure to a simple comment display object.
For the conversion method, refer to the following.

➟5.8.4 ■12 (1) Registering the characters of a text figure to a comment group
4) [Font]

Select the font.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows fonts

When selecting a Windows font, set the font style as necessary.

5) [Character Set]
Set the language.
Set this item when a Windows font is selected for [Font].

6) [Size]
Set the text size (width × height magnification or dots).
The setting range differs depending on the font type.

➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the text size cannot be set.

7) [Text Color]

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

Example)

[Text] dialog Screen

[Italic] button
[Underline] button
7. FIGURES
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Select the text color.
For the details of the color, refer to the following.

➟6.4 Color Settings
8) Text style

Set the style of the text to be displayed.
One style ([Bold], [Solid], or [Raised]) is settable only.

9) [Background Color]
Select this item to color the background of the text.

10) [Direction]
Select the direction of the text.
The following shows the items to be selected.

• [Horizontal]
• [Vertical]

When [TrueType Mincho], [TrueType Gothic], [Outline Kaisho], [Outline Gothic], [Outline], or a Windows font is 
selected for [Font], this setting is fixed to [Horizontal].

11) [Alignment]
Set the horizontal position of the text.
This item is applied when the text is entered in two or more lines.

12) [Line Space]
Set the space between lines.
The setting range is [0] to [128] dot(s).

13) [KANJI Region]
Select the KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

When [TrueType Mincho], [TrueType Gothic], or a Windows font is selected for [Font], this setting is not available.
14) [Category]

Select the category to which the figure belongs.
➟11.7 Managing figures and objects by category

15) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

(1) Displaying the text in the vertical direction

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

• [Solid Color]
When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

• Left button
Aligns the text to the left.

• Center button
Aligns the text to the center.

• Right button
Aligns the text to the right.

[Solid] button
[Raised] button

[Bold] button

Center button
Right button

Left button

[Japan] [China(GB)-Mincho]

Example) 
Difference between [Japan] and [China(GB)-Mincho]
7 - 4 7. FIGURES
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The following shows the text displayed in the vertical direction.

(2) Text supported by the GOT
(a) Text supported by the 6x8dot font

The 6x8dot font supports ASCII characters 20h to 7Eh.
When unsupported texts are used, the text is displayed differently between GT Designer3 and the GOT.

• For GT Designer3: The unsupported text is displayed as "■".
• For the GOT: The unsupported text and all subsequent texts cannot be displayed.

(b) Font for the GOT and GT Designer3
The GOT and GT Designer3 support the common Unicode 2.1-compliant fonts.
Thus, the GOT can display the languages used in various countries, including Japanese, Korean, 
Chinese (Pekingese), English, German, and French.
When using multiple languages, refer to the following section.

➟1.2.5 Font specifications
(3) Setting of the background color

[Background Color] and either of [Bold], [Solid], or [Raised] are selected for one setting, the text may be run 
off the left edge or top edge.

Example 1) In the case of "-"
Horizontal direction: Terminal
Vertical direction: T
                            e
                            r
                            m
                            i
                            n
                            a
                            l

Example 2) In the case of "()"
Horizontal direction: (Caution)
Vertical direction: (
                            C
                            a
                            u
                            t
                            i
                            o
                            n
                            )

Display on GT Designer3 Display on GOT

Not displayed

* Alphanumeric: A to Z, a to z, 0 to 9
  Symbol:           !,",#,$,%,&,',(,),*,+,-,,,.,/,:,;, 
                        <,=,>,?,@,[,\,],^,_,`,{,¦,},,space

Example)
7. FIGURES
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7.2 Drawing a Logo Text

Draw a logo text.

■1 How to draw
Step 1 Select [Figure]→[Logo Text] from the menu.
Step 2 Place the cursor on the position where you draw the text, and click on it.

The [Logo Text] dialog appears.
Step 3 Configure the settings in the [Logo Text] dialog.

➟7.2.1 [Logo Text] dialog
Step 4 After the setting, click the [OK] button.

The logo text is placed.

7.2.1 [Logo Text] dialog

■1 [Basic] tab

1) [Text]
Set the text to be displayed.
The input text is displayed on the screen.

Up to 512 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of characters.)

2) [Set as Default] button

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

5)

6)

2)
3)

4)

7)

Example)

[Logo Text] dialog Screen
7 - 6 7. FIGURES
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Sets the currently configured setting in the dialog as a default.
The default setting is applied at the next startup.

3) [Reset Default] button
Resets the default setting configured by the [Set as Default] button.

4) [Convert to Text Figure] button
Converts the logo text to the text.
The [Logo Text] dialog changes to the [Text] dialog.

➟7.1.1 [Text] dialog
5) [Text]

Item Description

[Font]

Select the font.
➟1.2.5 Font specifications
The following shows the items to be selected.
• [TrueType Mincho]
• [TrueType Gothic]
• Windows fonts

Text Style

Set the decoration of the text.

• [Bold] button
Boldifies the text.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

Alignment

Set the horizontal position of the text. 
This item is applied when the text is entered in two or more lines.

• Left button
Aligns the text to the left.

• Center button
Aligns the text to the center.

• Right button
Aligns the text to the right.

[Size]

Set the text size.
• [Horizontal]:

Set the width of the text.
The setting range is [1] to [800] dot(s).

• [Vertical]:
Set the height of the text.
The setting range is [1] to [800] dot(s).

[Text Color]

Select the text color. 
For the details of the color, refer to the following.
➟6.4.2 Color settings
When [Fill Effects] is selected, the text can be displayed with gradation or pattern.

[Background Color]

To make the background of the text transparent, do not select this item.
To color the background of the text, select this item.
For the details of the color, refer to the following.

➟6.4.2 Color settings

[Category]
Select the category to which the figure belongs.
➟11.7 Managing figures and objects by category

[Italic] button
[Underline] button

[Bold] button

Center button
Right button

Left button
7. FIGURES
7.2 Drawing a Logo Text
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6) [Effect]

7) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Advanced] tab

1) [Text]

Item Description

[Effect]

Select the effect type. 
The following shows the items to be selected.
• [Outline]
• [Solid]
• [3D]
• [Stamp]
• [Neon]

Preset list
Select the effect color from the 16 color shades. 
The selectable color shades differs depending on each effect type in [Effect]. 
After selecting the color, configure the detail setting in [Effect] in the [Advanced] tab.

[Ontline]              [Solid]                 [3D]                [Stamp]            [Neon]

Example)

Item Description

[Text Width] Set the width of the text. 
The setting range is [0] to [100] dot(s).

[Antialiasing] Set the value of the anti-aliasing (which eliminates the aliasing of pixels) for the text. 
The setting range is [0] to [100] dot(s).

[Text Space] Set the space between the texts. 
The setting range is [0] to [128] dot(s).

[Line Space] Set the space between lines. 
The setting range is [0] to [128] dot(s).

1)

2)
7 - 8 7. FIGURES
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2) [Effect]
Configure the setting for the effect.
The setting range differs depending on each effect type in [Effect] in the [Basic] tab.
If you set the effect in the [Advanced] tab, and then select the effect color from the preset list in the [Basic] tab, the 
advanced setting is reset and cannot be restored.
For information on how to set colors, refer to the following.

➟6.4 Color Settings

Item Description

For [Outline]

• [Outline Color]
Select the color of the outline.

• [Outline Width]
Set the width of the outline.
The setting range is [0] to [100] dot(s).

• [Outline Antialiasing]
Set the value of the anti-aliasing (which eliminates the aliasing of pixels) for the outline.
The setting range is [0] to [100] dot(s).

• [3D Display]
Select this item to display the logo text in three dimensions.

• [Illuminant Direction]
Set the illuminant direction in 3D display.
The following shows the items to be selected.
·[Top-left]
·[Bottom-left]
·[Top-right]
·[Bottom-right]

For [Solid] • [Solid Color]
Set the color of the shade.

• [Solid Width]
Set the width of the shade.
The setting range is [0] to [100] dot(s).

• [Solid Antialiasing]
Set the value of the anti-aliasing (which eliminates the aliasing of pixels) for the shade.
The setting range is [0] to [100] dot(s).

• [Solid Distance]
Set the position of the shade against the text by using the X-axis and Y-axis relative 
coordinates.
The setting range is [-20] to [20] dot(s).
7. FIGURES
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For [3D] • [Side Color]
Select the color of the three dimensional side.

• [Depth]
Select the depth of the three dimensional side.
The setting range is [0] to [20] dot(s).

• [3D Direction]
Set the direction of the three dimensions.
The following shows the items to be selected.
·[Top-left]
·[Bottom-left]
·[Top-right]
·[Bottom-right]

For [Stamp] • [Solid Color]
Set the color of the shade.

• [Solid Length]
Set the length of the shade.
The setting range is [0] to [20] dot(s).

• [Illuminant Direction]
Set the illuminant direction.
The following shows the items to be selected.
·[Top-left]
·[Bottom-left]
·[Top-right]
·[Bottom-right]

For [Neon]

• [Outline Color]
Select the color of the outline.

• [Outline Width]
Set the width of the outline.
The setting range is [0] to [100] dot(s).

• [Outline Antialiasing]
Set the value of the anti-aliasing (which eliminates the aliasing of pixels) for the outline.
The setting range is [0] to [100] dot(s).

• [Neon Color]
Select the color of the neon.

• [Neon Width]
Select the width of the neon.
The setting range is [0] to [100] dot(s).

• [Neon Antialiasing]
Set the value of the anti-aliasing (which eliminates the aliasing of pixels) for the neon.
The setting range is [0] to [200] dot(s).

Item Description
7 - 10 7. FIGURES
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7.3 Drawing a Line

Draw a line.

■1 How to draw
Step 1 Select [Figure]→[Line] from the menu.
Step 2 Draw the line on the screen.

• Basic drawing
Drag the pointer from the start point to the end point.

• Drawing with the [Shift] key pressed
The direction of the end point can be changed at every 45 degrees.

• Drawing with the [Ctrl] key pressed
The line is drawn with the start point as a center.

Step 3 Double-click the drawn line to display the [Line] dialog.

➟7.3.1 [Line] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)

1)

2)

45 degrees

1) 2)
Start point
7. FIGURES
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7.3.1 [Line] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Line Style]
Select the style of the line.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

2) [Line Width]
Select the width of the line.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

3) [Line Color]
Select the color of the line.
For the details of the color, refer to the following.

➟6.4.2 Color settings
4) [Name]

Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)
7 - 12 7. FIGURES
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■2 [Lamp Feature] tab

1) [Use lamp attribute]
Changes the color of the line by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting
2) [Lamp Attribute]

Set each item in the lamp attribute.

■3 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the line when the bit device is on.
• [Line Color]

Select the color of the line.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
7. FIGURES
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■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
7 - 14 7. FIGURES
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7.4 Drawing a Line Freeform

Draw a freeform line.

■1 How to draw
Step 1 Select [Figure]→[Line Freeform] from the menu.
Step 2 Draw the line on the screen.

Drag the pointer from the start point to the end point to draw the first line.

Step 3 To draw the next line, click the end point of the previous line.
• Basic drawing

• Drawing with the [Shift] key pressed
The direction of the vertex can be changed at every 45 degrees.

Step 4 To finish the drawing, double-click the last vertex.

Step 5 Double-click the drawn freeform line to display the [Line Freeform] dialog.

➟7.4.1 [Line Freeform] dialog

Editing the vertex
Select [Edit]→[Edit Vertices] from the menu to switch the size editing handle to the vertex editing handle.
The vertex editing handle enables the position of the vertex to be modified.
For details, refer to the following.
➟6.6.12 [Edit Vertices]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

1)

2)

45 degrees

4)
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7.4.1 [Line Freeform] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Line Style]
Select the style of the line.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

2) [Line Width]
Select the width of the line.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

3) [Line Color]
Select the color of the line.
For the details of the color, refer to the following.

➟6.4.2 Color settings
4) [Name]

Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)
7 - 16 7. FIGURES
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■2 [Lamp Feature] tab

1) [Lamp Attribute]
Changes the color of the freeform line by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting

■3 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the freeform line when the bit device is on.
• [Line Color]

Select the color of the line.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
7 - 18 7. FIGURES
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7.5 Drawing a Rectangle

Draw a rectangle and square.

■1 How to draw
Step 1 Select [Figure]→[Rectangle] from the menu.
Step 2 Draw the rectangle on the screen.

Drag the pointer from the start point to the end point.
• Basic drawing

• Drawing with the [Shift] key pressed
Draw the square.

• Drawing with the [Ctrl] key pressed
The rectangle is drawn with the start point as a center.

Step 3 Double-click the drawn rectangle to display the [Rectangle] dialog.

➟7.5.1 [Rectangle] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

1)

2)

1)

2)

Start point
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7.5.1 [Rectangle] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Line Style]
Select the style of the frame.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

2) [Line Width]
Select the width of the frame.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

3) [Line Color]
Select the color of the frame.
For the details of the color, refer to the following.

➟6.4.2 Color settings
4) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the rectangle is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
4)
5)
6)
7)
8)

9)
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5) [Shape Color]
Select the pattern color.

6) [Background Color]
Select the background color.

7) [Type]
Select the type of the corner.
The following shows the items to be selected.

• [Ordinary]
• [Rounded]
• [Octagonal]

For [Rounded], when the value other than [1 Dot] is selected for [Line Width], the line style is automatically changed 
to the straight line.
For [Rounded], when the style other than the straight line is selected for [Line Style], the line width is automatically 
changed to [1 Dot].

8) [Radius]
Set the radius of the corner.
Set this item when [Rounded] or [Octagonal] is selected for [Type].
The radius can be set from [0] dot.
The maximum value is the value calculated by dividing either of the vertical and horizontal sides of a rectangle, 
whichever is shorter, by 2. The value is rounded down after the decimal point. (Unit: dot)

9) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

  1:       ，   2:       ，   3:       ，   4:       ，   5:       ，   6:       ，   7:

  8:       ，   9:       ， 10:       ， 11:       ， 12:       ， 13:       ， 14:

15:       ， 16:       ， 17:       ， 18:       ， 19:       ， 20:       ， 21:

22:       ， 23:       ， 24:       ， 25:       ， 26:       ， 27:       ， 28: 

29:       ， 30:       ， 31:       ， 32:       ， 33:       ， 34:       ， 35:

36:       ， 37: 

[Ordinary]                          [Rounded]                         [Octagonal]

Example)
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■2 [Lamp Feature] tab

1) [Use lamp attribute]
Changes the color of the rectangle by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting
2) [Lamp Attribute]

Set each item in the lamp attribute.

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the rectangle when the bit device is on.
• [Line Color]

Select the color of the frame.
• [Pattern]

Select the pattern.
• [Shape Color]

Select the pattern color.
• [Background Color]

Select the background color.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■3 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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7.6 Drawing a Polygon

Draw a polygon.

■1 How to draw
Step 1 Select [Figure]→[Polygon] from the menu.
Step 2 Draw the polygon on the screen.

Drag the pointer from the start point to the end point to draw the first line.

Step 3 To draw the next line, click the end point of the previous line.
• Basic drawing

• Drawing with the [Shift] key pressed
The direction of the vertex can be changed at every 45 degrees.

Step 4 To finish the drawing, double-click the last vertex.

Step 5 Double-click the drawn polygon to display the [Polygon] dialog.

➟7.6.1 [Polygon] dialog

Editing the vertex
Select [Edit]→[Edit Vertices] from the menu to switch the size editing handle to the vertex editing handle.
The vertex editing handle enables the position of the vertex to be modified.
For details, refer to the following.
➟6.6.12 [Edit Vertices]
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7.6.1 [Polygon] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Line Style]
Select the style of the frame.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

2) [Line Width]
Select the width of the frame.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

3) [Line Color]
Select the color of the frame.
For the details of the color, refer to the following.

➟6.4.2 Color settings
4) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the polygon is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.
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5) [Shape Color]
Select the pattern color.

6) [Background Color]
Select the background color.

7) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Lamp Feature] tab

1) [Use lamp attribute]
Changes the color of the polygon by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting
2) [Lamp Attribute]

Set each item in the lamp attribute.

  1:       ，   2:       ，   3:       ，   4:       ，   5:       ，   6:       ，   7: 

  8:       ，   9:       ， 10:       ， 11:       ， 12:       ， 13:       ， 14:

15:       ， 16:       ， 17:       ， 18:       ， 19:       ， 20:       ， 21:

22:       ， 23:       ， 24:       ， 25:       ， 26:       ， 27:       ， 28: 

29:       ， 30:       ， 31:       ， 32:       ， 33:       ， 34:       ， 35:

36:       ， 37: 

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the polygon when the bit device is on.
• [Line Color]

Select the color of the frame.
• [Pattern]

Select the pattern.
• [Shape Color]

Select the pattern color.
• [Background Color]

Select the background color.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]
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■3 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
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7.7 Drawing a Circle

Draw a circle.

■1 How to draw
Step 1 Select [Figure]→[Circle] from the menu.
Step 2 Draw the circle on the screen.

Drag the pointer from the start point to the end point.
• Basic drawing

• Drawing with the [Shift] key pressed
A precise circle is drawn.

• Drawing with the [Ctrl] key pressed
The circle is drawn with the start point as a center.

Step 3 Double-click the drawn circle to display the [Circle] dialog.

➟7.7.1 [Circle] dialog
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7.7.1 [Circle] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Line Style]
Select the style of the frame.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

2) [Line Width]
Select the width of the frame.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

3) [Line Color]
Select the color of the frame.
For the details of the color, refer to the following.

➟6.4.2 Color settings
4) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the circle is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.
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5) [Shape Color]
Select the pattern color.

6) [Background Color]
Select the background color.

7) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Lamp Feature] tab

1) [Use lamp attribute]
Changes the color of the circle by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting
2) [Lamp Attribute]

Set each item in the lamp attribute.

  1:       ，   2:       ，   3:       ，   4:       ，   5:       ，   6:       ，   7:

  8:       ，   9:       ， 10:       ， 11:       ， 12:       ， 13:       ， 14:

15:       ， 16:       ， 17:       ， 18:       ， 19:       ， 20:       ， 21:

22:       ， 23:       ， 24:       ， 25:       ， 26:       ， 27:       ， 28: 

29:       ， 30:       ， 31:       ， 32:       ， 33:       ， 34:       ， 35:

36:       ， 37:

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the circle when the bit device is on.
• [Line Color]

Select the color of the frame.
• [Pattern]

Select the pattern.
• [Shape Color]

Select the pattern color.
• [Background Color]

Select the background color.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]
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■3 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
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7.8 Drawing an Arc or a Sector

■1 [Arc], [Sector]
Draw an arc or a sector.

■2 How to draw
Step 1 To draw the arc, select [Figure]→[Arc] from the menu.

To draw the sector, select [Figure]→[Sector] from the menu.
Step 2 First of all, draw a precise circle on the screen.

Drag the pointer from the start point to the end point.
Step 3 The fine broken line is displayed inside the circle.

Click the start point of the arc.

Step 4 Click the end point of the arc.
Drawing the arc or sector is completed.

Step 5 Double-click the drawn arc or sector to display the [Arc/Sector] dialog.

➟7.8.1 [Arc/Sector] dialog

7.8.1 [Arc/Sector] dialog

1) [Sector]
Select this item to use the sector.
Do not select this item when using the arc.

2) [Line Style]
Select the style of the frame.
The following shows the items to be selected.
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• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

3) [Line Width]
Select the width of the frame.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

4) [Line Color]
Select the color of the frame.
For the details of the color, refer to the following.

➟6.4.2 Color settings
5) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the arc or sector is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.

6) [Shape Color]
Select the pattern color.

7) [Background Color]
Select the background color.

8) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category
9) [Set as Default] button

Sets the currently configured setting in the dialog as a default.
The default setting is applied at the next startup.

10) [Reset Default] button
Resets the default setting configured by the [Set as Default] button.

11) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

  1:       ，   2:       ，   3:       ，   4:       ，   5:       ，   6:       ，   7:

  8:       ，   9:       ， 10:       ， 11:       ， 12:       ， 13:       ， 14:
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22:       ， 23:       ， 24:       ， 25:       ， 26:       ， 27:       ， 28: 
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7.9 Drawing a Table

Draw a table.

■1 How to draw
Step 1 Select [Figure] → [Table] from the menu.
Step 2 Draw a table on the screen.

Drag the pointer from the start point to the end point.

Step 3 Double-click the table to display the [Table] dialog.

➟7.9.1 [Table] dialog

7.9.1 [Table] dialog

➟■1 [Style] tab
■2 [Extended] tab

■1 [Style] tab

1) [Interval]
Select the row height and column width.
The following shows the items to be selected.

• [Even]
Distributes rows and columns evenly.
Dragging a handle on the table frame or a border automatically resizes rows and/or columns and distributes 
them evenly according to the table size.
Example) Changing the table width with the columns spaced evenly

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Individual]
Set the height of a row or the width of a column.
Dragging a handle on the table frame resizes the table with the locations of borders unchanged.
Example) Changing the table width with the locations of borders unchanged

Dragging a border only moves this border.
Example) Moving a border to change the width of a column

2) [Number of rows]
Set the number of rows.
The setting range depends on the setting of [Interval] and the table height.
The setting range is [1] row to [30] rows in the following cases.

• [Interval] is set to [Even].
• [Interval] is set to [Individual] and the table height is 31 dots or more.

When [Interval] is set to [Individual] and the table height is 30 dots or less, the setting range is [1] row to "Table 
height (dot) - 1" rows.
Example) When [Interval] is set to [Individual] and the table height is 4 dots
The setting range is [1] row to [3] rows.

3) [Number of columns]
Set the number of columns.
The setting range depends on the setting of [Interval] and the table width.
The setting range is [1] column to [30] columns in the following cases.

• [Interval] is set to [Even].
• [Interval] is set to [Individual] and the table width is 31 dots or more.

When [Interval] is set to [Individual] and the table width is 30 dots or less, the setting range is [1] column to "Table 
width (dot) - 1" columns.
Example) When [Interval] is set to [Individual] and the table width is 5 dots
The setting range is [1] column to [4] columns.

Drag the handle to the right.

Drag the handle to the right.

Drag the border to the right.
7. FIGURES
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4) [Frame]

5) [Border]

6) [Shading]

Item Description

[Line Style]

Select the style of the frame. 
The following shows the items to be selected.
• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

[Line Width]

Select the width of the frame. 
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Line Color]
Select the color of the frame. 
For the frame color, refer to the following.
➟6.4.2 Color settings

Item Description

[Line Style]

Select the style of the border. 
The following shows the items to be selected.
• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

[Line Width]

Select the width of the border. 
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Line Color]
Select the color of the border. 
For the border color, refer to the following.
➟6.4.2 Color settings

Item Description

[Pattern]

Select the pattern. 
The following shows the items to be selected.
• [None]:

Set no pattern.
The table frame and borders are displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.

[Shape Color]
Select the color of the pattern. 
For the pattern color, refer to the following.
➟6.4.2 Color settings

[Background Color]
Select the background color. 
For the background color, refer to the following.
➟6.4.2 Color settings

  1:       ，   2:       ，   3:       ，   4:       ，   5:       ，   6:       ，   7:

  8:       ，   9:       ， 10:       ， 11:       ， 12:       ， 13:       ， 14:
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22:       ， 23:       ， 24:       ， 25:       ， 26:       ， 27:       ， 28: 

29:       ， 30:       ， 31:       ， 32:       ， 33:       ， 34:       ， 35:

36:       ， 37:
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7) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Extended] tab

1) [Category]
Select the category to which the figure belongs.

➟11.7.1 Specifications of the category
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7.10 Drawing a Scale

Draw a scale.

■1 How to draw
Step 1 Select [Figure]→[Scale] from the menu.
Step 2 Draw the scale on the screen.

Drag the pointer from the start point to the end point.
• Basic drawing

• Drawing with the [Shift] key pressed
The scale is drawn with same length in vertical and horizontal directions.

• Drawing with the [Ctrl] key pressed
The scale is drawn with the start point as a center.

Step 3 Double-click the drawn scale to display the [Scale] dialog.

➟7.10.1 [Scale] dialog

7.10.1 [Scale] dialog

1) [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [255].
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2) [Direction]
Select the direction of the scale.
The following shows the items to be selected.

• [Horizontal]
• [Vertical]

3) [Center Line]
Select the center line which passes vertically through the scale.
The following shows the items to be selected.

• [None]
• [Center]

4) [Line Style]
Select the style of the line.
The following shows the items to be selected.

• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

5) [Line Width]
Select the width of the line.
The following shows the items to be selected.

• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

6) [Line Color]
Select the color of the line.
For the details of the color, refer to the following.

➟6.4.2 Color settings
7) [Category]

Select the category to which the figure belongs.
➟11.7 Managing figures and objects by category

8) [Set as Default] button
Sets the currently configured setting in the dialog as a default.
The default setting is applied at the next startup.

9) [Reset Default] button
Resets the default setting configured by the [Set as Default] button.

10) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Horizontal] [Vertical]

[Center][None]
7. FIGURES
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7.11 Drawing a Piping

Draw a piping.

■1 How to draw
Step 1 Select [Figure]→[Piping] from the menu.
Step 2 Draw the line to become the piping on the screen.

Drag the pointer from the start point to the end point to draw the first line.

Step 3 To draw the next line, click the end point of the previous line.
• Basic drawing

• Drawing with the [Shift] key pressed
The direction of the vertex can be changed at every 45 degrees.

Step 4 To finish the drawing, double-click the last vertex.
When 100 vertices are drawn, the drawing automatically ends.

Step 5 Double-click the drawn piping to display the [Piping] dialog.

➟7.11.1 [Piping] dialog

Editing the vertex
Select [Edit]→[Edit Vertices] from the menu to switch the size editing handle to the vertex editing handle.
The vertex editing handle enables the position of the vertex to be modified.
For details, refer to the following.
➟6.6.12 [Edit Vertices]
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7.11.1 [Piping] dialog

➟■1 [Style] tab
■2 [Lamp Feature] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Style] tab

1) [Piping Width]
Set the width of the piping.
The setting range is [3] to [100] dots.

2) [Line Color]
Select the color of the frame.
For the details of the color, refer to the following.

➟6.4.2 Color settings
3) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the piping is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.

4) [Shape Color]
Select the pattern color.

5) [Background Color]
Select the background color.

6) [Name]
Set the figure name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.
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■2 [Lamp Feature] tab

1) [Use lamp attribute]
Changes the color of the piping by turning on and off the bit device.

➟6.5.4 ■1 Lamp attribute setting
2) [Lamp Attribute]

Set each item in the lamp attribute.

Item Description

[Device] Specify the bit device.

[ON Setting]

Set the attribute of the piping when the bit device is on.
• [Line Color]

Select the color of the frame.
• [Pattern]

Select the pattern.
• [Shape Color]

Select the pattern color.
• [Background Color]

Select the background color.
• [Blink]

Select the blinking speed.
The following shows the items to be selected.
·[None]
·[Low]
·[Medium]
·[High]
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Layer]
Not available to GT21 and GS21.
Select the layer to place the figure.
The following shows the items to be selected.

• [Front]
• [Back]

2) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device on which the object is displayed.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
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7.12 Painting Figures

Paint areas or figures enclosed by lines.

■1 How to paint
Step 1 Select [Figure]→[Paint] from the menu.
Step 2 Place the cursor inside the area to be painted, and click it.

The [Paint] dialog appears.
Step 3 Configure the settings in the [Paint] dialog.

➟7.12.1 [Paint] dialog
Step 4 After the setting, click the [OK] button.

The paint mark is displayed in the painted area, and the painting is completed.

The paint mark is displayed on GT Desinger3 only.

Before painting
Draw the area to be painted as follows:
(1) Enclose the area with the straight lines

(2) Select the same color for all the lines enclosing the area.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.1

Click

Polygon is 
painted.

Straight line

Straight line Straight line

Straight line

Straight line

Straight line

This area is painted.

This area is 
painted.

Draw the lines in the same color. Draw the lines in the same color.

This area is painted.
This area is painted.
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7.12.1 [Paint] dialog

1) [Boundary Color]
Select the same color as the one for all the lines enclosing the area.
For the details of the color, refer to the following.

➟6.4.2 Color settings
2) [Pattern]

Select the pattern.
The following shows the items to be selected.

• [None]:
Set no pattern.
Only the frame line of the figure is displayed.

• Other than [None]:
Select a pattern.
The following shows the items to be selected.

3) [Shape Color]
Select the pattern color.

4) [Background Color]
Select the background color.

5) [Category]
Select the category to which the figure belongs.

➟11.7 Managing figures and objects by category
6) [Set as Default] button

Sets the currently configured setting in the dialog as a default.
The default setting is applied at the next startup.

7) [Reset Default] button
Resets the default setting configured by the [Set as Default] button.

(1) Precautions
• Place the area to be painted behind the paint mark.

If the area is placed on the front of the paint mark, the area cannot be painted.
• Do not select the same color for the area as the one for the lines enclosing the area.

If the same color is selected, the area cannot be painted.
• Enclose the area to be painted without any clearance between the lines.

If there is any clearance between the lines, the paint is run off the lines.
• If the same color is selected for [Boundary Color] and either of [Shape Color] or [Background Color], the 

area may not be painted.
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In such a case, shift the position of the paint mark.
(2) Display on the screen editor

(a) When a part of the area is unpainted
In some cases, a part of the area is unpainted.
Redisplay the screen editor, and check whether the whole area is painted.

➟2.6.3 Redisplaying a selected screen editor
(b) When the paint mark is not displayed

When the paint mark is not displayed in the window, the area cannot be painted.
Display the paint mark in the window, and paint the area properly.

Paint mark
When the paint mark is displayed

When the paint mark is not displayed
7 - 46 7. FIGURES
7.12 Painting Figures



7

FI
G

U
R

ES
7.13 Pasting an Image File

Import an image file to GT Designer3, and paste it on the screen.

■1 Applicable image files
The following types of image files can be pasted.

(1) BMP file

If an image extends to the temporary area, the extended part is not displayed on the GOT.
Resize or reposition the image to fit into the screen display area.
For details on the size of images displayable on the GOT when the base screen size expansion is enabled, refer to the 
following.

➟5.1.3 ■3 (4) Size of images displayable on the expanded base screens

(2) JPEG file

If an image extends to the temporary area, the extended part is not displayed on the GOT.
Resize or reposition the image to fit into the screen display area.
For details on the size of images displayable on the GOT when the base screen size expansion is enabled, refer to the 
following.

➟5.1.3 ■3 (4) Size of images displayable on the expanded base screens

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Type of file 24-bit BMP, 256-color BMP, 16-color BMP, Monochrome BMP

Number of colors 65536 colors or less 
(The colors which cannot be displayed on the GOT are subtracted.)

Maximum size of images that can be pasted

Size of the temporary area of the screen editor on which an image is pasted

➟2.6 Basic Operations of the Drawing Screen
If an image extends beyond the temporary area, the image is resized vertically and 
horizontally proportional to the original size to fit into the temporary area.

Item Description

Format RGB full color-compliant baseline JPEG (JFIF, EXIF)

Number of colors 65536 colors or less 
(The colors which cannot be displayed on the GOT are subtracted.)

Maximum size of images that can be pasted

Size of the temporary area of the screen editor on which an image is pasted

➟2.6 Basic Operations of the Drawing Screen
If an image extends beyond the temporary area, the image is resized vertically and 
horizontally proportional to the original size to fit into the temporary area.
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(3) PNG file

If an image extends to the temporary area, the extended part is not displayed on the GOT.
Resize or reposition the image to fit into the screen display area.
For details on the size of images displayable on the GOT when the base screen size expansion is enabled, refer to the 
following.

➟5.1.3 ■3 (4) Size of images displayable on the expanded base screens

(1) Transparent area and semi-transparent area (α channel) of PNG file 
The transparency of the transparent area and semi-transparent area of the PNG file differs 
according to the data before the PNG file is imported (the value of α channel).
• Transparent area (α=0) 

The transparent area displays the background color.
• Semi-transparent area (0<α<1) 

The color of the semi-transparent area is combined with the background color.
(2) Placing PNG files 

When a PNG image with an α channel is placed on the front layer and there are no other images 
in the background, the translucent part of the image is superimposed on the transparent color of 
the screen. 
Because the composite color is different from the transparent color of the screen, the back layer 
cannot be seen.

Item Description

Format
32-bit PNG data with RGB+αchannel 
α channel (transparency information) supported,  
RGB 24-bit PNG

Number of colors 65536 colors or less 
(The colors which cannot be displayed on the GOT are subtracted.)

Maximum size of images that can be pasted

Size of the temporary area of the screen editor on which an image is pasted

➟2.6 Basic Operations of the Drawing Screen
If an image extends beyond the temporary area, the image is resized vertically and 
horizontally proportional to the original size to fit into the temporary area.
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■2 How to paste
Step 1 Select [Figure]→[Import Image Data] from the menu.

The [Open] dialog appears.
Step 2 Select the image file to be pasted.

When you paste the JPEG file, set [JPEG Quality].
[Low]: The image quality deteriorates, and the file size becomes smaller.
[High]: The image quality improves, and the file size becomes larger.

Step 3 Click the [Open] button.
The imported image file is pasted on the screen editor.

Step 4 Click the position where you paste it.
Pasting is completed.

Pasting the image file by drag-and-drop
The image file can be pasted on GT Designer3 screen by drag-and-drop.

■3 Editing the image
The following shows how to edit the pasted image.

(1) Editing the image
Step 1 Double-click the image to be edited.

Step 2 When you edit the image of the BMP file, the [Bitmap Attribute Change] dialog appears.
Click the [Open image data in Paint] button.
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Step 3 The paint window of Windows appears.
Edit the image on the paint window.

Step 4 After editing, select [File]→[Update document] from the menu.
The paint window is closed, and editing is completed.

(2) Setting the transparent color
When the pasted image file is a BMP file, you can select a color for transparent setting.

Step 1 Double-click the image to be edited.

Step 2 The [Bitmap Attribute Change] dialog appears.
Click the [Specify a transparent color for image data] button.

Step 3 The [Transparent Setting] dialog appears.

➟7.13.1 [Transparent Setting] dialog
Select [Enable the transparent setting].
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Step 4 Select the color to be transparent in the preview image.

Step 5 The selected color becomes transparent.
To save the image, click the [OK] button.

Step 6 Setting is completed.

■4 Precautions
(1) For BMP file

The color of the image displayed on GT Designer3 and the GOT may be slightly different from the color of the BMP file.

(2) For JPEG file
In the following cases, the image quality may deteriorate.

• When the pasted JPEG file is in the JFIF format, and not the baseline JPEG
• When the pasted image of the JPEG file is edited

To avoid the image quality deterioration, use the BMP file.

(3) For GT21 and GS21
The GOT may not display an image with dimensions larger than those of the screen display area on the screen editor.
Adjust the dimensions of the image to fit into the screen display area.
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(4) For Windows 11
Paint in Windows does not open even when an image pasted to the screen is double-clicked.
When editing an image, edit it by using image editing software and paste the edited image to the screen.

7.13.1 [Transparent Setting] dialog

Transparent setting is available using the image file displayed in the preview.
Depending on how to display this dialog, either of the following images is displayed in the preview.

• Image file pasted on the screen editor
• Image file selected by clicking the [From image] button in the [Image File Setting] dialog

1) [Enable the transparent setting]
This option is displayed only when a transparent color is set for the image file pasted on the screen editor.
Select the checkbox to enable the setting.

2) Zooming in or out the preview
Used to zoom in or out the preview.

3) [Transparent]
Displays a transparent color.

4) [Background Color]
Set a background color for the preview.

➟6.4.2 Color settings
5) Preview

Displays the image file.
The color of the area clicked is set as a transparent color.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

5)

3) 4)
2)

Click the color you want to set as a transparent color. The color becomes transparent and the color set as 
[Background Color] is displayed.

The color of the area clicked is set as [Transparent].
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7.14 Pasting DXF Data

Import the data of the DXF file (AutoCAD Data Exchange Format file) to GT Designer3, convert the data into the figure 
data of GT Designer3, and paste it on the screen.

■1 Supported version of DXF file
The DXF files with the following versions are supported.

• R12
• R13
• R14

To use the DXF file with unsupported version, change to any of the above versions.

■2 How to paste
Step 1 Select [Figure]→[Import DXF Data] from the menu.

The [Open] dialog appears.
Step 2 Select the DXF file to be pasted.

Step 3 Click the [Open] button.
The figure data is pasted on the screen editor.

Step 4 Click the position where you paste it.
Pasting is completed.

(1) Editing the figure data
The figure data of the DXF file is grouped.
For information on how to edit a grouping of figures, refer to the following.

➟6.6.8 [Group], [Ungroup]
(2) Pasting the file by drag-and-drop

A desktop file or a file in a folder can be directly pasted on the GT Designer3 screen by drag-and-drop.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Convertible information
(1) Convertible data

The following data of the DXF file can be converted into the data of GT Designer3.

(a) Converting the figure data
The figure data is converted from the data of the DXF file as below.

*1 When the number of vertices of the freeform line or polygon is 1000 or more, 1000th or more vertices cannot 
be displayed on the GOT.
Draw the figure on GT Designer3 so that the number of vertices will be 999 or less.

DXF data 
(Before pasting)

GTD3 data 
(After pasting) Remarks

ARC Arc -

ATTDEF (Skipped) -

ATTRIB Text

• The text size is converted to the nearest one within the range of 0.5 to 8 
dots.

• The direction of the text is converted to the nearest one at every 90 
degrees.

• The text style and inclination angle are not converted.

CIRCLE Circle -

DIMENSION Group The color and line style are converted based on the definition of BLOCK 
instead of the layer of DIMENSION.

ELLIPSE Circle or Arc When the main axis is inclined, the figure is converted so that its main axis 
will be rotated to vertical or horizontal.

INSERT Group
• The color and line style are converted based on the definition of BLOCK 

instead of the layer of INSERT.
• The scale and rotation angle are not converted.

LEADER Line Freeform*1 The figure is converted to the freeform line by connecting each vertex with 
the straight line.

LINE Line -

LWPOLYLINE Line Freeform*1or Polygon*1
• The figure is converted to the freeform line or polygon by connecting each 

vertex with the straight line.
• The figure with curved lines is not converted.

MLINE Line Freeform*1

• MLINESTYLE is not converted.
The color and line style of the freeform line are converted based on the 
layer definition.

• Cap processing is not supported.

MTEXT Text

• The text size is converted to the nearest one within the range of 0.5 to 8 
dots.

• The direction of the text is converted to the nearest one at every 90 
degrees.

• The format code and text style are not converted.

POINT Circle, Rectangle, or Line -

POLYLINE Line Freeform*1or Polygon*1
• The figure is converted to the freeform line or polygon by connecting each 

vertex with the straight line.
• The figure with curved lines is not converted.

SEQEND (End of sequence data) -

SOLID Polygon -

SPLINE Line Freeform*1or Polygon*1 The figure is converted to the freeform line or polygon by connecting each fit 
point with the straight line.

TEXT Text

• The text size is converted to the nearest one within the range of 0.5 to 8 
dots.

• The direction of the text is converted to the nearest one at every 90 
degrees.

• The text style and inclination angle are not converted.

TRACE Polygon*1 -
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(b) Converting the line
The line width is converted to 1 dot.
The line style is converted as below.

(c) Converting the color
The color is converted as below.

Editing the figure data after pasted
Only the figure data of the DXF file which can be pasted on GT Designer3 is converted. Therefore, a part of the 
figure data may not be displayed as original data.
The following shows some of the examples.

• φ cannot be displayed.
→As φ in DXF file is not the shift JIS code, it cannot be converted.

• BLOCK consisting of line and circle is enlarge-displayed.
→As the scale is set in INSERT, BLOCK cannot be displayed in the proper size.

Check the figure and adjust it as necessary.

DXF data 
(Before pasting)

GTD3 data 
(After pasting) Image

CONTINUOUS Straight line

DASHED Coarse broken line

HIDDEN Coarse broken line

CENTER Speck chain line

PHANTOM Two-dot long and two short 
dashes line

User definition Straight line

Others Straight line

DXF data 
(Before pasting)

GTD3 data 
(After pasting)

Red (0x01) Red (0xE0)

Yellow (0x02) Yellow (0xFC)

Green (0x03) Green (0x1C)

Light blue (0x04) Light blue (0x1F)

Blue (0x05) Blue (0x03)

Purple (0x06) Purple (0xE3)

White (0x07) White (0xFF)

Black (0x08) Black (0x00)

Dark red (0x09) Dark red (0xC0)

Dark yellow (0x0A) Dark yellow (0xF0)

Dark green (0x0B) Dark green (0x18)

Dark-light blue (0x0C) Dark-light blue (0x1E)

Dark blue (0x0D) Dark blue (0x02)

Dark purple (0x0E) Dark purple (0xC3)

Dark white (0x0F) Dark white (0xFE)

Others White (0xFF)
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(2) Precautions
• The data with the layer off cannot be converted.
• Only the shift JIS code text is compatible.
• Regardless of the unit, the dimension 1 on the DXF file is converted to 1 dot on GT Designer3.
• To import the figure data to GT Designer3, the dimension should be 2048×1536 or smaller.

If the width or height exceeds the above size, the figure data cannot be imported.

• Some DXF files may require 10 minutes or more for importing.
• The pasted figure data is registered in [Other] in [Category].

Example) Figure data which cannot be imported

2048

1536
The dimension 

exceeds 2048x1536.
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7.15 Pasting IGES Data

Import the data of the IGES (Data Exchange Format among CADs) to GT Designer3, convert the data into the figure data 
of GT Designer3, and paste it on the screen.

■1 Supported IGES file
The supported files are the wire frame format IGES files (*.igs, *.ige, *.iges) with Autodesk Inventor manufactured by 
Autodesk, Inc..

■2 How to paste
Step 1 Select [Figure]→[Import IGES Data] from the menu.

The [Open] dialog appears.
Step 2 Select the IGES file to be pasted.

Step 3 Click the [Open] button.
The [Preview] dialog appears, and the figure data is displayed.

Step 4 Click the [Option] button to display the [Option] dialog.
Set the optimization level for converting the curved line to freeform line.
[Low]: The image quality deteriorates, and the file size becomes smaller.
[High]: The image quality improves, and the file size becomes larger.
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Step 5 Adjust the size and direction of the figure data.
• Left drag: Rotates the figure data to the direction in which it is dragged.
• Right drag: Moves the figure data to the direction in which it is dragged.
• Left and right drag to upward : Increases the size of the figure data.
• Left and right drag to downward: Decrease the size of the figure data.

The figure data is pasted on the screen in the size and direction displayed in the [Preview] dialog.
Step 6 After adjusting, click the [Save] button.

The figure data is pasted on the screen editor.
Step 7 Click the position where you paste it.

Pasting is completed.

Editing the figure data
The figure data of the IGES file is grouped.
For information on how to edit a grouping of figures, refer to the following.
➟6.6.8 [Group], [Ungroup]

■3 Precautions
(1) Data which cannot be imported

When the IGES file has unsupported entity, the following dialog is displayed.

Clicking the [No] button displays the [Preview] dialog; however, the unsupported entity and subsequent ones are not 
imported.
The following shows the examples.

• Parent entity (importable)-child entity (importable)-grandchild entity (not importable)
→Although the parent entity and child entity are imported, the grandchild entity is not imported.

• Parent entity (importable)-child entity (not importable)-grandchild entity (importable)
→Although the parent entity is imported, the child entity and grandchild entity are not imported.

• Parent entity (not importable)-child entity (importable)-grandchild entity (importable)
→As the parent entity is not importable, all the entities are not imported.

(2) Importable entities
GT Designer3 supports the entities defined by JAMA-IGES.
The following shows the importable entities.

Entity name Entity ID

Circle 100

Ellipse 104

Line 110

Transformation matrix 124

Rational B-spline curve 126

General note 212

Subfigure definition 308

Color definition 314

Subfigure entity 408
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(3) Nested format groups
When some groups are nested in the IGES file, only the bottom level groups are imported.

(4) Displaying the figure data which cannot be imported on the GOT
To display the figure data which cannot be imported on the GOT, capture the screen image using the Windows 
screenshot function and paste the image file.

➟7.13 Pasting an Image File

Group 1

Group 3

Group 4

Group 2
Group 1

Group 3

Group 4

IGES file After importedExample)
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8.1 Using Objects in the Library

The library contains figures, objects, templates, and images.
You can place them on a screen.
They are preset or user-created.

8.1.1 Specifications of the library

■1 Registerable library data types
(1) Figure

Figures drawn by the user.

(2) Object
Objects set by the user.

(3) Template
Templates set by the user.
For the details of the templates, refer to the following.

➟11.6 Efficient Drawing with Templates

(4) Image file
BMP files, JPEG files, and PNG files.

■2 Library classifications
The following shows the library classifications.

(1) [System Library]
This folder stores the preset figures, objects, templates, and images.
You can select them from the subfolders below.

• [Search By Subject] folder: Data are classified by appearance.
• [Search By Function] folder: Data are classified by function.

The [Search By Subject] folder and the [Search By Function] folder store the same data.

(2) [My Library]
This folder stores the user-created figures, objects, templates, and imported images.
You can create library folders to store the library data in [My Library].
Create folders for each purpose.

Library folder
Up to two hierarchies can be created in a library folder.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) [My Favorites]
Register library data that is used frequently.
The library data registered as [My Favorites] is displayed on the [My Favorites] tool bar.

(4) [Recently Used Library]
Up to 10 library data sets that are used by the user recently are recorded.
The data is not registered in this folder, and you cannot add, delete, or edit the library data in this folder.

■3 Screen configurations
The following shows the screen of the library.

(1) [Library] window
A window for operating the library data.

For the details of [Library] window, refer to the following.
➟8.1.4 [Library] window

8.1.2 How to use the library

The following shows what you can do with libraries and each reference section.
• Using the data registered in the library

➟■1 Using the data in the library
• Registering figures, objects, or templates as the library data

➟■2 Registering the data in the library
• Copying and pasting the library data

➟■3 Copying the library data
• Deleting the library data

➟■4 Deleting the library data
• Editing the library data

➟■5 Editing the library data
• Changing the attribute of the library data

➟■6 Changing the attribute of the library data
• Saving my library

➟■7 Saving the library data
• Opening the saved my library

➟■8 Opening the library data
• Importing the library data or image files

➟■9 Importing the library data
• Saving library folders in my library

Library data areaLibrary tree area

Toolbar area

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟■10 Exporting the library data

■1 Using the data in the library

Select library data and place on the screen editor.
Step 1 Select the library data to be used from the library.

Step 2 Click a location on the screen editor where the library data is placed.
The library data is arranged.

(1) Using the data in [My Favorites]
The library data registered in [My Favorites] can be selected from the My Favorites tool bar as well.

(2) Using with changing size
You can change the size of the library data placed on the screen data by dragging a mouse.

(3) Using templates
For the details of the templates, refer to the following.

➟11.6.2 How to use the template
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■2 Registering the data in the library

(1) Creating library data
Step 1 Set a location for registering the library data.

Select a folder to store the data from [My Library] and double-click.
To create a new folder, double-click the [Create New Folder] button.

Step 2 Click the [Create New Library Data] button.
New library data is displayed.

Step 3 Place a figure, object or template on the library editor to edit.

For how to edit the library data, refer to the following.
➟■5 Editing the library data

Step 4 When you complete the editing, click the [Close] button.
The library data closes.

Step 5 To change the library data number or the library data name, refer to the following.

➟■6 Changing the attribute of the library data

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Click.

[New Data] is created.

Library editor is displayed.
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Registering the data on the screen editor to the library
Figures, objects, templates on the screen editor can be registered to the library with the following method.
(1) Dragging

Drag a figure, object, or template on the screen editor to the library tree area or the library data area to 
register the data as the library data.

The data is registered in the library folder in [My Favorites] or [My Library].
(2) Registering from the right-click menu

Select a figure, object, or template on the screen editor and select [Register to My Favorites] from the right-
click menu to register the data to [My Favorites].

(2) Registering figure used as object
Step 1 Display the object setting dialog.

Step 2 Select a figure from the preview list and click the [Figure] button.
The [Image List] dialog is displayed.

Step 3 Select a library folder where figure is to be registered.
The data is registered in the library folder in [My Favorites] or [My Library].

Step 4 Click the [Register Here] button.

Drag

2. Click.1. Select a figure for registration.
8 - 6 8. OBJECT FUNCTION
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Step 5 The [Library data Property] dialog is displayed.
Set [Number] and [Name] of the library data and click the [OK] button.

Step 6 A figure is registered to the library folder.

Click.

3.

4.

Select a library for 
registering the figure.
8. OBJECT FUNCTION
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■3 Copying the library data

Step 1 Select a library folder or a library data to be copied from the library.

Step 2 Click the [Copy] button.

Step 3 Select the copy destination folder and click the [Paste] button.

Step 4 If library data having the same number as the copy source library data exists, the [Overwriting the Library 
Data Confirmation] dialog is displayed.

• To overwrite the library data, click the [Yes] button.
• To overwrite all the library data, click the [All Yes] button.
• To not to overwrite the library data, click the [Save as Different Number] button and set a new number.
• To cancel pasting, click the [No] button.
• To cancel the pasting of all the data, click the [Cancel] button.
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Click.

2. Click.
1. Select a copy destination.
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■4 Deleting the library data

Step 1 Select a library folder or a library data to be deleted from the library.

Step 2 Click the [Delete] button.

Step 3 The following dialog appears.
Clicking the [Yes] button deletes selected library folder or the selected library data.

Click.

Set a new number.
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Click.
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Deleting the library folder
Note that deleting the library folder deletes all the library data sets registered in the library folder as well.

■5 Editing the library data

Step 1 Select a library folder to be edited.

Step 2 Click the [Edit] button.

Step 3 The library data editor is displayed.
Edit the library data.
The edited contents are reflected to the library data immediately.

To cancel the wrong edited contents, click the [Undo] button before closing the library editor.
The edited contents are determined after the library editor is closed.

Step 4 When you completed editing the library data, close the screen.
Click the [Close] button on the top right of the screen.
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Click.
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(1) Utilizing another data to the library data
Utilize the library data by the following methods.
(a) Copying a figure, object, or template

By copying data on the screen editor to the library editor, you can use the data on the library data.
(b) Utilizing another data

You can paste another library data on the library editor.
(2) Displaying the library editor by the double-click operation

You can display the library editor by double-clicking the library data on the library data area.

■6 Changing the attribute of the library data

Step 1 Select a library data for changing the attribute.

Step 2 Click the [Attribute Change] button.

Step 3 The [Library data Property] dialog is displayed.
Set the number and name of the library data.
After setting, click the [OK] button to determine the change of the attribute of the library data.
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Click.
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■7 Saving the library data

The library data in [My Library] and [My Favorites] can be saved as the different library from using library.
By saving multiple user-created libraries in the hard disk of the personal computer, you can use multiple user-created 
libraries at drawing.

➟8.1.2 ■8 Opening the library data
In addition, by copying a user-created library to other personal computers, you can use the same library in multiple 
personal computers.

Step 1 Select [My Library] on the library tree and select [Save My Library] from the right-click menu.

Step 2 The [Save My Library] dialog is displayed.
Click the [Browse] button to specify the saving destination.
The folder name of saved library is fixed to [MyLibrary].
If the library has already saved in the specified saving destination, the data is overwritten.
When you do not overwrite the data, specify another saving destination.
After specifying, click the [OK] button.

Step 3 The [MyLibrary] folder is created in the specified folder and the library data registered in [My Library] and 
[My Favorites] are saved.

(1) Saved library file
Do not execute operations such as add, delete, or change the name to saved [MyLibrary] folder of files in 
the folder.
The library may not be read properly.

(2) Saving multiple libraries
If the library has already saved in the specified saving destination, the data is overwritten.
When you do not overwrite the data, specify another saving destination.

(3) Name of saved library file
[My Favorites] folder is saved as [000_My Favorites.my2].
The file name of [My Library] is determined according to the library folder number and name.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

...

Library-1

Save 
the library 
folder.

Save multiple libraries in the hard disk 
of the personal computer.

(Example 1) (Example 2)

Copy.

Share the created libraries 
in multiple personal computers.

Library-2
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Example) When the library folder number is 1 and the name is abc

■8 Opening the library data

You can use [My Library] or [My Favorites] saved in other projects in the creating project.
The current library is replaced with the library saved in other projects.

Step 1 Select [My Library] on the library tree and select [Open My Library] from the right-click menu.

Step 2 When the library is being edited, the dialog for confirming whether to save the library is displayed.
Click the [Yes] button to save the library, click the [No] button not to save the library.

0 0 1 _ a b c . m y 2

Folder number

Folder name

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Library of the project being edited

Utilize library.

Library of another project
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Step 3 The [Open My Library] dialog is displayed.
Click the [Browse] button.

Step 4 Specify the folder where the library to be read is saved (the folder one level higher than [MyLibrary] folder).
After specifying the folder, click the [OK] button to replace the library.

■9 Importing the library data

You can use the library data created in other projects by importing.
In addition, imported image files can be registered as the library data.
Up to 512 pieces of library data can be stored in one library folder.
The following shows importable file types.

• [My Library File (*.my2,*.mlb,*.lbe)]
Exported library data sets.
my2 file: Library data exported from GT Designer3 (GOT2000).
mlb file: Library data exported from GT Designer3 (GOT1000).
lbe file: Library data exported from GT Designer2.

• [Import Library File (*.il2,*.ilb)]
Library files to be imported to the system library.
Obtain library files by one of the following methods.
· Go to the following directory: [(Path to the installation location of GT Designer3)\GTD3_2000\App\LibraryData].
· Contact your local distributor.
The imported library files are deleted when you update the version of GT Designer3.
Import the library files again as necessary.

• [Image File (*.bmp,*.jpg,*.jpeg,*.jpe,*.png)]
Image files used as the library data.

A folder one level higher 
than the MyLibrary folder

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Importing the library data
Step 1 Click the [Import] button.

Step 2 Select [Files of type].

Step 3 Select the file to be imported and click the [Open] button.

Step 4 When a library folder having the same number as the imported library exists, [Overwriting the Library Folder 
Confirmation] dialog is displayed.

• When you overwrite the library data, click the [Yes] button.
• When you do not overwrite the library data, click the [No] button.

The library folder is not imported.
• To abort all imports when importing multiple library folders, click the [Cancel] button.
• To change the folder number to be imported, click the [Save as Another Number] button.

Click.
8. OBJECT FUNCTION
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Step 5 The my library file is added to [My Library] and the imported library file is added to [System Library].
When you import [My Favorites], unused library number is assigned automatically.

Importing by drag operation
You can import the library folder by dragging.

(2) Importing image data
Step 1 Click the [Import] button.

Step 2 In the [Import Library] dialog, select [Image File (*.bmp,*.jpg,*.jpeg,*.jpe,*.png)] for [Files of type].

Drag.

Click.
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Step 3 Select the file to be imported and click the [Open] button.
Specifying multiple files is also available.

Step 4 In the [Choose import folder] dialog, select a library folder for saving the file, and click the [OK] button.

Step 5 In the [Confirm Library data number specification] dialog, perform one of the following operations.

• To display the [Input Library data number] dialog, click the [Yes] button.
For specifying the library data number, refer to the following.

➟(a) [Input Library data number] dialog
• To save the file with a vacant library number assigned automatically, click the [No] button.

When multiple files are selected, the [Confirm Library data number specification] dialog appears 
repeatedly for each file.

• To save all the files with vacant library numbers assigned automatically, click the [All No] button.
8. OBJECT FUNCTION
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• To cancel the import process and close the [Confirm Library data number specification] dialog, click the 
[Cancel] button.

(a) [Input Library data number] dialog
Specify the library data number for the file to be imported.

1) [Library data No.]
Displays a vacant library data number.
The number is changeable.
The setting range is [1] to [512].

2) [Skip] button
Switches the library data number to the start number of the subsequent consecutive vacant numbers. 

3) [Consecutive vacant No.]
Displays the number of consecutive vacant numbers, beginning with the current library data number.

4) [Number of Image Files to be Imported]
Displays the number of files to be imported.

5) [Yes] button
Saves the file with the vacant number specified in [Library data No.].

6) [All Yes] button
Saves the files with the consecutive vacant numbers, starting from the number specified in [Library data No.].
When the number of files to be imported exceeds that of the current consecutive vacant numbers, the subsequent 
vacant numbers are used to save all the files.
When [Library data No.] is set to 513 or larger, even if consecutive vacant numbers starting with a number less than 
513 exist, the import process is stopped.

7) [No] button
Returns to the [Confirm Library data number specification] dialog.

1) 2)
3)
4)

6)
5) 7)

[Library data No.] 1～100 101～200

101 301 451
Vacant Vacant

201～300 301～400 451～512

401～450

VacantBeing used

Being 
used

Skip Skip

Skip

Being used
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■10 Exporting the library data

Export the library data registered in [My Library] in units of folder.
You can use the exported library data in other projects.
[My Favorites] and [System Library] cannot be exported.

Step 1 Select the library folder to be exported from the library tree and click the [Export] button.

Step 2 The [Export Destination Specification] dialog is displayed.
Set [Save in] and [File Name] and click the [Save] button.
The export is completed.

8.1.3 Precautions for libraries

■1 Registering figures and objects on the screen editor
Figures and objects up to 2000 dots × 1600 dots can be registered in the library.
No figure or object whose vertical or horizontal size exceeds the above size can be registered.
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Project-1 Project-2

Export Import

2. Click.1. Select.
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8.1.4 [Library] window

Figures, objects and image data are stored in the library.
Select [View] → [Docking Window] → [Library List] from the menu to display the [Library] window.

1) Display bar
The display statuses of the library data area are displayed.

2) Move bar

• [Library Group]
Switches the library type to be displayed on the library data area.
The selected library contents are displayed on the library data area.

• [Library Folder Name]
Select the library folder to be displayed on the library data area from the libraries 
selected in the library group.

• [Color]
Switch the color system of figures to be displayed on the library data area.
This item is available when selecting [System Library] folder.
The following shows the items to be selected.
• [All]
• [Blue]
• [Red]
• [Yellow]
• [Green]
• [Orange]
• [Light Blue]
• [Purple]
• [Pink]
• [Gray]
• [Gold]
• [Silver]
• [Black]
• [White]

• [ON], [OFF]
Switches display or non-display of figures displayed on the library data area.

• [Display format]
Switches the display format of figures displayed on the library data area.
The following shows the items to be selected.
• [150%], [100%], [75%], [50%], [25%]: Displays the library data with selected 

scale.
• [Thumbnail]: Displays the library data with a certain size.
• [Detail]: Displays the library data and attribute value with a certain size.

• [Back]
Moves to the previous library folder.

• [Forward]
Moves to the next library folder.

• [Upper]
Moves to a one level higher library folder.

• [Tree View]
Switches display or non-display of a library tree.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Library data area

Library tree area

Edit bar
Display bar

Move bar

Display formatLibrary group

ON/OFF

Color

Library folder name
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3) Edit bar

4) Library tree area
Clicking the [Tree View] button on the toolbar switches display or non-display of trees.

• [Create Library Folder]
Creates a library folder.

• [New Library Data]
Creates library data.

• [Register Data]
Registers the data selected on the screen editor as the library data.

• [Delete]
Deletes the selected library folder or library data.

• [Cut]
Cuts the selected library folder or library data.

• [Copy]
Copies the selected library folder or library data.

• [Paste]
Pastes the copied library folder or library data.

• [Edit]
Edits the selected library data.

• [Edit Attribute]
Changes attributes of the library folder or the library data.
When the library data in the system library is selected, the library data property is 
displayed.

• [Import]
Imports library folders or image files.

• [Export]
Exports the selected library folder.

Item Description

Library tree configurations
• [Import]

Imports library folders or image files.
➟8.1.2 ■9 Importing the library data
• [Recently Used Library]

Displays the library data that is used by the user recently on the library data area.
• [My Favorites]

A folder where library data that is used frequently is registered.
When you open the folder, registered library data is displayed on the library data area.

• [My Library]
A folder where user-created library folders are stored.

• [Create Folder]
Creates a library folder.

• User-created library folder
A folder where the library data is registered.

• [System Library]
A folder where figures, objects, templates that are registered in advance are stored.

• [Search by Appearance]
A folder where library data that is classified by appearance is stored.
The same library data is stored in the [Search by Function] folder as well.

• [Search by Function]
A folder where library data that is classified by functions is stored.
The same library data is stored in the [Search by Appearance] folder as well.

Operation by buttons on the move bar and the 
edit bar

Operate the library tree by buttons on the move bar and the edit bar.
➟2) Move bar
3) Edit bar

User-created library folder
8. OBJECT FUNCTION
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5) Library data area
Displays the contents of the selected library data.
Figures are displayed or hidden by [ON] or [OFF] of the display bar.

Right-click operation

The library tree can be selected from the right-click menu.

• [Open]
Displays the contents in the library folder to the library data area.

• [Unfold]
Displays the one hierarchy of contents in the library folder to the library data area.

• [Unfold All]
Displays the all hierarchies of contents in the library folder to the library data area.

• [Fold]
Folds the one hierarchy of library folder displayed in the library tree.
Subfolders are not folded.

• [Fold All]
Folds the all hierarchies of library folder displayed in the library tree.
Subfolders are folded.

• [Create Library Folder]
Creates a library folder in [My Library].
A deed-number is assigned to the created library folder automatically, and the name of 
the folder is [New Folder].

• [Save My Library]
Saves the library data registered to [My Favorites] and [My Library].
➟8.1.2 ■7 Saving the library data
• [Open My Library]

Displays a library created in another project.
➟8.1.2 ■8 Opening the library data
• [Edit Attribute]

Displays the [Library Data Property] dialog.
(The number and name of the library folder can be changed.)
➟8.1.2 ■6 Changing the attribute of the library data
• [Create Library Data]

Creates library data in [My Favorites] and [My Library] folder.
➟8.1.2 ■7 Saving the library data
• [Rename]

Changes the number and name of the library folder.
• [Delete]

Deletes a library folder.
➟8.1.2 ■4 Deleting the library data
• [Cut]

Cuts a library folder.
• [Copy]

Copies a library folder.
• [Paste]

Pastes a library folder.
• [Export]

Exports a library folder.

Item Description
8 - 22 8. OBJECT FUNCTION
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Item Description

Operation by buttons on the move bar and the 
edit bar

Operate the library data area by buttons on the move bar and the edit bar.
➟2) Move bar
3) Edit bar

Right-click operation

The library data area can be operated from the right-click menu.

• [Edit]
Edits the library data.
➟8.1.2 ■5 Editing the library data
• [Edit Attribute]

Changes the number and name of the library data.
• [Rename]

Changes the name of the library data.
• [Delete]

Deletes library data.
➟8.1.2 ■4 Deleting the library data
• [Cut]

Cuts library data.
• [Copy]

Copies library data.
• [Create Library Data]

Creates library data.
➟8.1.2 ■2 Registering the data in the library
• [Paste]

Pastes the copied library data.
• [Export]

Exports a library folder.

Library data 
nameLibrary data 

number
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8.2 Placing a Touch Switch

■1 Switch
You can set multiple actions of touch switches.
Up to 147 actions can be set on a switch.

➟8.2.4 [Switch] dialog

■2 Bit switch
Turns on or off a bit device.

➟8.2.5 [Bit Switch] dialog
• Turning on a specified bit device (Set)

• Turning off the specified bit device (Reset)

• Alternating the current status of the specified bit device (ON←→OFF) (Alternate)

• Turning on the specified bit device only while the touch switch is touched (Momentary)
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X0001: OFF
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STOP
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■3 Word switch
Changes the value of a word device.

➟8.2.6 [Word Switch] dialog
• Writing the set value to a specified word device (Constant)
• Writing the set word device value to the specified word device (Indirect device)
• Writing the set word device value and the constant to the specified word device (Constant + Indirect device)

■4 Go To Screen switch
Switches base screens and window screens.

➟8.2.7 [Go To Screen Switch] dialog
• Switching to the screen with the base screen number previously displayed
• Switching to the screen with a specified screen number
• Switching to the screen with the specified screen number by turning on or off the specified bit device
• Switching to the screen with the specified screen number when the current value of the specified word device 

corresponds to the set conditional expression

■5 Change Station No. switch
Switches the device of the currently monitored object to the same device with another station number.

➟8.2.8 [Change Station No. Switch] dialog
• Switching the monitor target to a specified station number
• Switching the monitor target to the specified station number by turning on or off the specified bit device
• Switching the monitor target to the specified station number when the current value of the specified word device 

corresponds to the set conditional expression

■6 Special function switch
Switches the screen to the utility screen, the extended function screen, or other screens.

➟8.2.9 [Special Function Switch] dialog

380
380

Target value

Base screen 1 Base screen 2

50

Station No.1 Station No.2

Station
 No.1

50

Station
 No.2

Station
 No.1

130

Station
 No.2

Switching the monitor target
to the station No.2

Monitoring the station No.1

130

Sequence 
Program 
Monitor 
(Ladder)

MO V    1     D1

MO V    2     D2

RST    V

MO V    90  D162

MO V    110 D167

MO V    100 D172

SET M 9028

DUTY  35 0  400  M 9020

K

K

K

K

K

KK

-   1234   D100
K

P0 M999
187

D1 D2 V D162 D167 D172
1 2 47 90 110 100

↑ ↓ ← →
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■7 Key window display switch
Displays a specified key window at a specified position.
Displays a cursor on a specified object.

➟8.2.10 [Key Window Display Switch] dialog

■8 Key code switch
Enables key input into the numerical input and text input, alarm display, data list display, and alarm control.

➟8.2.11 [Key Code Switch] dialog

■9 Sound output
Plays or stops a sound.
Mutes or unmutes the sound.

Set the sound output in [Add Action] in the [Switch] dialog.
➟8.2.4 [Switch] dialog

Set a sound file used for the sound output in the [Sound File List] dialog.
➟10.12.6 [Sound File List] dialog

150
×

150

1 A

A B C D E F G DEL
H I J K - ESC

1 ABC

A B C D E F G DEL
H I J K - ESC

Operation
starts.
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8.2.1 Specifications of touch switch

The following shows the specifications of the touch switch.

■1 Maximum number of objects arrangeable on one screen
Up to 1024 touch switches and other objects can be placed on one screen.

■2 Switch action
Multiple functions can be set on one switch. (If the special function switch is set, multiple-function setting is disabled.)

*1 The action order (except for the key window display, key code, and dialog) can be changed in the [Action] tab.
When multiple actions are set on one switch, the switch functions according to the above order by default.
Reading/writing data from/to devices are executed for all the set switch actions at once.
The order in which the bit, word, and double-word devices are handled in each controller is determined by the 
specifications of the controller.
Accordingly, the actions (word set, bit set, bit reset, bit alternate, and bit momentary) that are set for the switch may not 
be executed in the user-specified order.
If an error occurs while the GOT reads the data from the device, the GOT does not write the data to the device.
If an error occurs while the GOT writes the data to the device, the GOT writes the data to the device for the other assigned 
actions.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Action order Action type Maximum number of actions Change of action order *1

Higher priority

Lower priority

Key window display 1

UnavailableKey code 16

Sound output 1

Word set 20

Available

Bit set 20

Bit reset 20

Bit alternate 20

Bit momentary 20

Base 1

Overlap window 1 1

Overlap window 2 1

Overlap window 3 1

Overlap window 4 1

Overlap window 5 1

Superimpose window 1 1

Superimpose window 2 1

Station No. Switching 21

Dialog window 1 Unavailable

Total 147
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• Action example 1
When the following actions and action order are set, if an error occurs during the action of (1) Key code, the 
processing is interrupted.
Thus, the action of (2) Bit set is not executed.
(1)Key code: FFBBh (Save alarm contents to data storage)
(2) Bit set

• Action example 2
When the following actions and action order are set, if an error occurs while the GOT reads the data (the previous 
value of the bit) from the device for the action of (2) Bit alternate, the processing is interrupted.
Thus, neither (1) Word set nor (3) Bit set is executed.
(1) Word set
(2) Bit alternate
(3) Bit set

• Action example 3
When the following actions and action order are set, if an error occurs while the GOT writes the data (the alternated 
value of the bit) to the device in the action of (2) Bit alternate, the processing is not interrupted.
Thus, both (1) Word set and (3) Bit set are executed.
(1) Word set
(2) Bit alternate
(3) Bit set

■3 Minimum size of touch switch
The minimum size of the touch switch is 2 dots (height) × 2 dots (width).

(1) Key code
Action

(2) Bit set
Error

Not executed

(2) Bit alternate

Action

(3) Bit set
Error

Not executed(1) Word set

Not executed

(2) Bit alternate

Action

(3) Bit set
Error

Executed(1) Word set

Executed
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■4 Hierarchy mode and history mode of the Go To Screen switch
(1) Hierarchy mode and history mode

When using the previous screen display touch switch, select the hierarchy mode or history mode.

(a) Hierarchy mode
The screen returns to the base screen in the higher hierarchy when you touch the touch switch. 
The screen can return to the base screen of up to the 10 level higher in the hierarchy.
Example)

After the screen is switched in the order of (1) → (2) → (3), the screen returns to the base screen 1 in the higher hierarchy 
by touching the previous screen display touch switch on the base screen 2.

(b) History mode
The screen returns to the immediately previous base screen when you touch the touch switch.
The screen can return to up to 10 previous base screens.
Example)

After the screen is switched in the order of (1) → (2) → (3), the screen returns to the immediately previous base screen 
3 by touching the previous screen display touch switch on the base screen 2. (The screen returns to the base screen 2 
then base screen 1 at every touch on the previous screen display touch switch on each screen.)

(2) Hierarchy mode and history mode information
When the GOT is powered off, the hierarchy and history information becomes invalid.
When the GOT is powered off and on again, the screen does not return to the screen displayed before the power off even 
you touch the previous screen display touch switch.
For details of how to save the history information in a memory card, refer to the following.

➟8.2.1 ■4 (4) Saving the history information in the memory card

(3) How to switch the hierarchy mode and history mode
The default setting is the hierarchy mode.
The following shows how to use the previous screen display touch switch in the history mode.

(a) Selecting the history mode on GT Designer3
Step 1 Select [Common]→[GOT Environmental Setting]→[Screen Switching/Windows] from the menu.
Step 2 Select [History] in [Back Screen Switching].

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

(b) Switching to the history mode with the GOT internal device (GS450.b14)
Turn on the GOT internal device (GS450.b14).
Use the trigger action function to turn on the above device.
For application examples, refer to the following.

➟8.2.1 ■4 (4) (b) Example of settings configured to switch the modes with the GOT internal device

(4) Saving the history information in the memory card
In the history mode, the GOT can save a maximum of 10 screens in the history information to the memory card installed 
in the GOT.
Once the GOT saves the history information, the screen can return to the previous screen displayed before the power off 
even the GOT is powered off and on again.
The following shows how to save the history information in the memory card.

• Enabling the history information to be saved in the memory card in GT Designer3 settings.
Step 1 Select [Common]→[GOT Environmental Setting]→[Screen Switching/Windows] from the menu.
Step 2 Select [History] in [Back Screen Switching], and then select [Store history to the memory card].

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

Base screen1 Base screen2 Base screen3

(1) (2)

(3)

Base screen1 Base screen2 Base screen3

(1) (2)

(3)
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• Enabling the history information to be saved in the memory card with the GOT internal device (GS450.b13).
In the history mode (when GS450.b14 is on), turning on the GOT internal device (GS450.b13) enables the history 
information to be saved in the memory card. 
For application examples, refer to the following.

➟(b) Example of settings configured to switch the modes with the GOT internal device

(a) Operation overview
After the GOT is powered on, the GOT reads the history information in the memory card at the first screen switching.

(1) After the screen is switched to the next screen, the GOT is powered off.
(2) After the GOT is powered on, touch the previous screen display touch switch in the history mode, and then the screen 
returns to the previous screen displayed before the power off.
(3) When the screen is switched to the next screen after the GOT is powered on, the screen also returns to a maximum 
of 10 previous screens displayed before the power off.

(b) Example of settings configured to switch the modes with the GOT internal device
Set the history mode in the first row in the [Project] tab of the [Trigger Action] dialog.
Immediately after the GOT is powered on, the mode is changed to the history mode.
For details of the trigger action, refer to the following.

➟9.5 Operating a Device as a Trigger ([Trigger Action])
After screen transition is performed and then the mode is changed from the hierarchy mode to the history mode, the GOT 
loses the screen information and thus the screen may not return according to the history.
If you use the history mode, set the history mode immediately after the GOT is powered on.

Line A statusRUN

300
150

Target production quantity

GOT power OFF → GOT power ON

Line A statusRUN

300

Target production quantity
Station
No.1

Station
No.2

Screen switching operation
History mode operation

(2) (3)

(1)

150

POWER RUN STOP LADDER

Password

Line ctrl screen

POWER RUN STOP LADDER

Password

Line ctrl screen

Setting for history mode

Setting for saving
the history information
in the memory card
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8.2.2 How to use touch switch

The following shows how to use touch switches.

■1 Arranging touch switches
Arrange touch switches on a screen editor.

➟6.5.1 Placing figures and objects

■2 Editing touch switches
Edit touch switches arranged on the screen editor.

➟6.5.3 Editing figures and objects

■3 Setting touch switches
Configure the settings for touch switches arranged on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Settings of touch switches
➟8.2.4 [Switch] dialog

8.2.5 [Bit Switch] dialog
8.2.6 [Word Switch] dialog
8.2.7 [Go To Screen Switch] dialog
8.2.8 [Change Station No. Switch] dialog
8.2.9 [Special Function Switch] dialog
8.2.10 [Key Window Display Switch] dialog
8.2.11 [Key Code Switch] dialog

■4 Disabling the simultaneous press for a touch switch
When the simultaneous press is disabled for a touch switch, touching any areas on the GOT screen is disabled while the 
switch is being touched.
Configure the setting for disabling the simultaneous press in the setting dialog for each touch switch.
Select [Simultaneous Press] in the [Extended] tab, and select [ON Priority] or [OFF Priority].

➟(2) Action for [ON Priority] and [OFF Priority]

(1) Touch switches that support disabling the simultaneous press
All touch switches support disabling the simultaneous press.
In the following cases, [Simultaneous Press] is selected, and the on/off priority is fixed to [ON Priority].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Touch switch type Description

Special function switch
The setting is always fixed.
The setting is also applied to a switch to which [SP Function] is added as a switch action.

Key code switch

The setting is fixed when [Alarm Display] is selected for [Key Code Type] in the [Key Code] tab, and one 
of the following is selected for [Action].
• [Display ladder]
• [Display ladder (Sequence Program Monitor (Ladder))]
• [Display ladder (Sequence Program Monitor (iQ-R/iQ-L Ladder))]
• [Display ladder (Sequence Program Monitor (iQ-F Ladder))]
The setting is also applied to a switch to which [Key Code] is added as a switch action.
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(2) Action for [ON Priority] and [OFF Priority]

Touch switch operation
Touch switch action

[ON priority] [OFF priority]

1. Touch the touch invalid area of the touch switch.
2. Slide the finger to the touch valid area of the touch switch.
3. Release the finger from the touch switch.

At operation 1.: Remains off.
At operation 2.: Turns on.
At operation 3.: Turns off.

At operation 1.: Remains off.
At operation 2.: Remains off.
At operation 3.: Remains off.
For GT21 and GS21, the 
action is the same as [ON 
Priority].

1.Touch the touch valid area of the touch switch.
2. Slide the finger to the touch invalid area of the touch switch.
3. Release the finger from the GOT screen. At operation 1.: Turns on.

At operation 2.: Remains on.
At operation 3.: Turns off.
For GT21 and GS21, the 
action is the same as [OFF 
Priority].

At operation 1.: Turns on.
At operation 2.: Turns off.
At operation 3.: Remains off.

1. Touch the touch switch.
2. Touch the area where no object is arranged.
3. Release the finger from the touch switch.
4. Release the finger from the area where no object is arranged. At operation 1.: Turns on.

At operation 2.: Remains on.
At operation 3.: Remains on.
At operation 4.: Turns off.

At operation 1.: Turns on.
At operation 2.: Turns off.
At operation 3.: Remains off.
At operation 4.: Remains off.
For GT21 and GS21, the 
action is the same as [ON 
Priority].

1. Press touch switch A for which the simultaneous press is disabled.
2. Touch the touch switch B.
(The touch switch action is the same whether the simultaneous press is enabled 
or disabled for touch switch B.)

Action of touch switch A
At operation 1.: Turns on.
At operation 2.: Remains on.
Action of touch switch B
At operation 1.: Remains off.
At operation 2.: Remains off.

Action of touch switch A
At operation 1.: Turns on.
At operation 2.: Turns off.
Action of touch switch B
At operation 1.: Remains off.
At operation 2.: Remains off.
For GT21 and GS21, the 
action is the same as [ON 
Priority].

Place touch switch A for which the simultaneous press is disabled on the front 
layer and touch switch B for which the simultaneous press is enabled on the back 
layer. Then, press the area where the touch switches overlap with each other.

Action of touch switch A
At operation 1.: Remains off.
Action of touch switch B
At operation 1.: Turns on.

A B A B

A
B
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(3) Slide operation and simultaneous press
When you slide the finger from the touch key invalid area to the touch key valid area, the GOT recognizes the operation 
as touching multiple areas simultaneously.
The GOT cannot distinguish between sliding the finger across multiple areas and touching multiple areas simultaneously 
using two fingers.
Therefore, the GOT recognizes sliding the finger from the touch key invalid area to the touch key valid area as touching 
multiple areas simultaneously.
Due to the same reason, the GOT recognizes sliding the finger from the touch key valid area to the touch key invalid area 
as the simultaneous press.

8.2.3 Precautions for a touch switch

This section explains the precautions for the touch switch.

■1 Precautions for drawing
(1) Reducing basic figures in size

When a basic figure is set on the touch switch, reducing the touch switch in size may not display the figure properly.

(2) Valid range of the touch switch
The unit for the valid area of the touch switch is one dot.
Right-click the mouse on the object, then [Edit Touch Area] appears. You can set the shape and valid area of the touch 
switch individually.
Also, the valid area of the touch switch fits in the object frame by executing [Self-adjust].

➟6.6.14 [Edit Touch Area]

Touch the valid area
and invalid area 
of the touch key simultaneously.

Slide the finger across the valid area
to/from the invalid area of the touch key.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen 1 Shape of touch switch

Valid area of touch switch
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(3) Superimposing the touch switch and the object
(a) Touch switches that cannot be superimposed

Do not superimpose the following touch switches on another touch switch.
Simultaneous press is prohibited (ON priority) for the following touch switches even if [Simultaneous Press] is not set.
The following touch switches do not function when superimposed on other touch switches or objects for which touch 
operation is available.

(b) Superimposing the key window display switch and other touch switches
In the following cases, other touch switches superimposed with the key window display switch do not function.

• When another touch switch is arranged under the key window display switch by using the superimpose window or 
the set overlay screen

• When the object ID of the superimposed touch switch is larger than that of the key window display switch
If the touch switch does not function, arrange it on the key window display switch by using the superimpose window or 
the set overlay screen.
For superposition by using the superimpose window or the set overlay screen, refer to the following.

➟6.5.5 ■3 Superimposition

(c) Go To Screen switch or switches for which the screen switching function is set
For superposition on the following objects, when [When a finger is touched (ON synchronous)] is set for [Action of Go To 
Screen Switch] in GOT Environmental Setting, arrange the objects so that the screen switching is functioned last.
Even if the following objects are arranged so that they function after the screen switching, they do not function.

• Touch switch
• Numerical input
• Text input

For the action order of the superimposed objects, refer to the following.
➟6.5.5 ■3 Superimposition

(4) Using parts as touch switch shapes
For the GOT to which the project has been written, when editing only parts data or deleting the parts data which has been 
written to the GOT, check the setting of the touch switch shape again.
If the size of the parts is changed, the touch switch may not be displayed properly.
If the parts data is deleted, only the text is displayed but not the touch switch shape.
If the parts data has been updated, the data of all the touch switches and lamps which uses the updated parts needs to 
be updated. Therefore,saving the project data or opening the communication dialog may need longer time than usual.

(5) Setting [Repeat the operation while the switch is pressed]
(a) Precautions for touch switches for which operation repeat is set

(b) Touching simultaneously multiple touch switches for which the operation repeat is set
When multiple touch switches are touched simultaneously for which the operation repeat is set, only the operation of the 
last touched switch is repeated.

Key code Description Key code type

FFBCh Display ladder Alarm Display

FFBDh Display ladder (Sequence Program Monitor (Ladder)) Alarm Display

FFBAh Display ladder (Sequence Program Monitor (iQ-R/iQ-L Ladder)) Alarm Display

FFC3h Displaying ladder (Sequence Program Monitor (iQ-F Ladder)) Alarm Display

- Special function switch -

Touch switch type Precaution

Switch

When the operation repeat is set for the switch, do not set the special function, the screen switching function, 
or the station No. switching function.
If the special function, the screen switching function, or the station No. switching function is set, the operation 
repeat setting is invalid.

Bit switch If bit momentary is set for the action, the operation repeat setting is invalid.

Word switch None

Key window display switch
In the following cases, the operation repeat is aborted.
• A key window is displayed while the operation is repeated.
• A key window is already displayed.

Key code switch If a dialog window is displayed while the operation is repeated, the operation repeat is aborted.
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(6) Converting the touch switch to lamp
(a) Settings to be deleted

When the touch switch has been converted to a lamp, some of the settings are deleted.
The deleted settings are applied as the default setting for the lamp.

(b) Converting basic figures
For converting the basic figure from the touch switch to the lamp, the figure of the switch is converted to the corresponding 
figure with the same number on the lamp.
Example: Converting the touch switch to the lamp when the basic figure [Square_3D_Fixed Width _Push] is set for the 
touch switch

When the touch switch is converted to the lamp under the following conditions, the default basic figure is set.
• No basic figure on the lamp has the same number as the basic figure set for the touch switch.
• The basic figure [Toggle] is set for the touch switch.
• The basic figure [Selector] is set for the touch switch.

Even if the shapes have the same reference number, there may be difference between the touch switch and the lamp. 
Check the shape after the conversion to see if it can be properly used.

(c) Restoring the lamp to the touch switch after the conversion
To restore the lamp to the switch after conversion, select [Edit]→[Undo] from the menu.
Even if the lamp has been converted back to the touch switch, the previous settings cannot be restored.
If the [OK] button is not clicked, clicking the [Cancel] button cancels the conversion even after the [Convert to Lamp] 
button is clicked.

(d) Types of the lamp to be converted to
The type of the lamp to be converted to differs depending on the setting of [Lamp (Timing to change shape/text)].

• When [Key Touch State] or [Bit-ON/OFF] is selected
The touch switch is converted to a bit lamp.

• When [Word Range] is selected
The touch switch is converted to a word lamp.

If no setting item for [Lamp (Timing to change shape/text)] exists , the touch switch is converted to the bit lamp.

(7) Mode of the word switch
When [Data Addition] or [Data Subtraction] is set for [Mode] of the word switch, the GOT with an old basic system 
application may not operate.
In such a case, install the latest basic system application to the GOT.

Convertingto the corresponding 
basic figure

Convertingto the shape of the 
same number
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(8) Channel No. setting of the special function switch
When the project data is saved or the GOT type is changed, if the channel No. set for the special function switch does 
not exist, the channel No. is automatically changed.
When either of the following functions is set for the special function switch, check the channel No. of the special function 
switch.

• Sequence program monitor (ladder)
• Sequence program monitor (SFC)

(9) Multiple key code settings
The following key codes must be set last, as the other key codes will not be executed if set after them.

Key code Description Key code type

000Dh Writes to the device and moves the cursor. Numerical input/Text input

001Bh Hides the cursor. Numerical input/Text input

0080h Moves the cursor to the right. Numerical input/Text input

0081h Moves the cursor to the left. Numerical input/Text input

0082h Moves the cursor upward. Numerical input/Text input

0083h Moves the cursor downward. Numerical input/Text input

0084h Convert the entry to kanji or Simplified Chinese 
characters. Numerical input/Text input

0085h Displays the previous option Numerical input/Text input

0086h Displays the next option Numerical input/Text input

0087h Select/Not convert Numerical input/Text input

0092h Moves the cursor in the user ID ascending order Numerical input/Text input

0093h Moves the cursor in the user ID descending 
order Numerical input/Text input

FFB4h Change the selected alarm status to "Checked" 
(Check) Alarm Display

FFB5h Change all the alarm statuses to "Checked" 
(Check all) Alarm Display

FFB6h Delete the selected restored alarm (Delete) Alarm Display

FFB7h Delete all the restored alarms (Delete all) Alarm Display

FFB8h Displays the detail/Moves to the lower 
hierarchy. Alarm Display

FFB9h Resets the selected alarm data. Alarm Display

FFBBh Saves the alarm details to the data storage. Alarm Display

FFC2h Moves to the upper hierarchy. Alarm Display
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■2 Precautions for use
(1) Simultaneous 2-point press
(a) For GT27

GT27 supports the simultaneous touch of up to two points.
For safety, you can create a screen that operates by touching two touch switches simultaneously.
The areas where the 2-point press is inactive are displayed with broken lines.

For the display method of the two-point press inactive area, refer to the following.
➟2.6.6 Displaying the two-point press inactive area

　 11.10.5 ■1 [Options] dialog ([View] tab)
When placing touch switches for the simultaneous 2-point press, note the following.

• Do not place touch switches for the simultaneous 2-point press in one two-point press inactive area.
If you simultaneously touch two points in one two-point press inactive area, an untouched area may respond.

• If you simultaneously touch two points on a boundary line across two-point press inactive areas, the touch switches 
may not function.

• If you simultaneously touch one point on a boundary line across two-point press inactive areas, and another point in 
a two-point press inactive area adjacent to the line, the touch switches may not function.

Two-point press inactive area

Boundary line across two-point 
press inactive areas

Boundary line across two-point 
press inactive areas
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(b) For GT25, GT23, GT21, GS25, and GS21
The simultaneous 2-point press is not available.
Do not touch two or more points on the GOT screen simultaneously.
The simultaneous touch of two or more points may cause the untouched area to respond.

(2) Setting a delay
(a) When [Press Twice] is set

If the touch switch has been touched only once and another monitor screen is operated, [Press Twice] does not function 
properly.

(b) When [Press Twice] and the operation repeat are set
The operation repeat is invalid at the first touch.
The operation repeat is valid at the second touch.

(3) Setting the bit set, bit reset, or bit alternate together with screen switching and station No. switching
When the bit set, bit reset, or bit alternate action is set together with the screen switching or station No. switching, the 
timing of the screen switching and station No. switching differs depending on the status of GS450.b12.
Set GS450.b12 before the first action of the touch switch.
This enables the status of the device after screen switching to be changed.

The following shows an example in which GS450.b12 automatically turns on after the GOT is powered on by using the 
trigger action.

• Setting example of the trigger action
Set the GOT internal device (Always ON device: GS0.b4) as a trigger in the first low in the [Project] tab of the [Trigger 
Action] dialog so that GS450.b12 is on when the trigger is on.
After the GOT is powered on, the trigger action turns on GS450.b12.
For the details of the trigger action, refer to the following.

➟9.5 Operating a Device as a Trigger ([Trigger Action])

Two-point press inactive areas 
adjacent to a boundary line

Two-point press inactive areas 
adjacent to a boundary line

Setting item
GS450.b12

ON OFF

Screen switching or Station No. switching + Bit set When the finger is released from the touch 
switch When the finger touches the touch switch

Screen switching or Station No. switching + Bit reset When the finger is released from the touch 
switch When the finger touches the touch switch

Screen switching or Station No. switching + Bit alternate When the finger is released from the touch 
switch When the finger touches the touch switch

Screen switching or Station No. switching + Bit 
momentary When the finger is released from the touch switch

Screen switching or Station No. switching + Word When the finger touches the touch switch When the finger touches the touch switch
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Example) The following actions are set simultaneously for the touch switch
Bit alternate: M100
Screen switching: The screen switches to base screen 2 when M100 is on.
Screen switching: The screen switches to base screen 1 when M100 is off.

(a) Switching action when GS450.b12 is on
After the bit set, bit reset, or bit alternate action is executed, the screen or the station number is switched when you 
release the finger from the switch. The GOT operates with the value after the bit set, bit reset, or bit alternate action.

(b) Switching action when GS450.b12 is off
At the same timing as the bit set, bit reset, or bit alternate action, the screen or the station number is switched. The GOT 
operates with the value before the bit set, bit reset, or bit alternate action.

M100 turns on 
when the finger touches
the touch switch.

The screen switches
when the finger is released
from the touch switch.

M100 turns off
when the finger touches
the touch switch

The screen switches
when the finger is released
from the touch switch.

Base screen 50 Base screen 2 Base screen 2 Base screen 1

M100 M100 M100 M100

Base screen 1 Base screen 1 Base screen 2Base screen 50

M100 turns on
and the screen switches
when the finger touches
the touch switch. 
(The GOT operates with the value
(M100: OFF) before the bit alternate.)

M100 turns off
and the screen switches
when the finger touches
the touch switch. 
(The GOT operates with the value 
(M100: ON) before the bit alternate.)

M100 M100 M100M100
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(4) When [Repeat the operation while the switch is pressed] is set
(a) Irregular operation repeat cycle

When communication time is longer than the preset operation repeat cycle, the cycle may be irregular.
To correct the cycle, take measures including setting a longer time for start delay or repeat cycle or reducing the number 
of monitor target devices.
Example) When the operation repeat is applied to the word switch that adds one to the device value

• When the operation is repeated normally
Every time the touch switch is operated, one is added to the device value.

• When the operation repeat cycle is irregular
Even if the touch switch is operated, the device value may not be increased.

(b) Abort of the operation repeat
If a dialog window is displayed while the operation is repeated, the operation repeat is aborted.

(c) Duration of touch on the touch switch and the process of writing to the device
While the value is written to the device, the GOT recognizes that the touch switch is touched.
Thus, even if the finger is released from the touch switch within the preset start delay time, a long device writing process 
may cause the GOT to recognize that the switch is touched longer than the start delay time, and which may repeat the 
operation.
In this case, set a longer start delay time.

(d) Switching action while the touch switch is touched
Security switching, language switching, or station No. switching is not executed while the touch switch is touched.
When the trigger device value for security switching, language switching, or station No. switching has been changed while 
the touch switch is touched, the switching is executed when the finger is released from the switch.

(5) Hierarchy mode and history mode of the Go To Screen switch
• When the history information is saved in the memory card, do not change the value of the screen switching device 

at the controller side while the GOT is powered off.
While the GOT is powered off, the history information is not saved. Therefore, the screen does not return according 
to the screen transition controlled on the controller side.

• Once the mode is changed from the hierarchy mode to the history mode, the mode does not return to the hierarchy 
mode until the GOT is powered off even if GS450.b14 is turned off.
This applies to GS450.b13.

• To change the mode from the hierarchy mode to the history mode using the GOT internal device (GS450.b14), select 
the hierarchy mode in GT Designer3 settings.
When the history mode is selected in GT Designer3 settings, the on and off status of GS450.b14 is invalid.

Setting item Setting

Device D100

Constant 0

Indirect device D100

0 1 2 3

First touch Second touch Third touch

0 1 2 2

First touch Second touch Third touch
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8.2.4 [Switch] dialog

Multiple functions can be assigned to one touch switch.
Step 1 Select [Object] → [Switch] → [Switch] from the menu.
Step 2 Click the position where you arrange the switch.
Step 3 Double-click the arranged switch to display the setting dialog.

➟■1 [Action] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab
■6 [Script] tab

■1 [Action] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Action List]
Displays the actions assigned to the switch in the list.

2) [Add Action]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

9)

6)

2)

8)

3)
4)
5)
7)

10)
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Select actions to be added to [Action List].

Item Description

[Bit] button

Sets the on and off operation of the bit device for the switch in the [Action (Bit)] dialog.
➟8.2.5 [Bit Switch] dialog

• [Device]
Set the device to which the value is written.
➟6.1.2 How to set devices
• [Action]

Select the function to be performed for the bit device as the destination when you touch the switch.
• [Momentary]:

Keeps the bit device on only while you touch the switch.
• [Alternate]:

Switches the on or off status of the bit device every time you touch the switch.
• [Set]:

Turns on the bit device when you touch the switch.
• [Reset]:

Turns off the bit device when you touch the switch.
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[Word] button

Sets how to change the value of the word device in the [Action (Word)] dialog.
➟8.2.6 [Word Switch] dialog

• [Device]
Set the device to which the value is written.
➟6.1.2 How to set devices
• [Data Type]

Select the data type of the values set in [Setting Value] and [Initial Value Condition].
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

➟1.2.7 ■2 Data type of devices
• [Mode]

Set the writing mode for the specified word device.
• [Custom]:

Select this item to write the value set in [Setting Value] to the specified word device.
• [Data Addition]:

Select this item to add the value set in [Variation] to the value stored in the specified word device.
• [Data Subtraction]:

Select this item to subtract the value set in [Variation] from the value stored in the specified word 
device.

• [Setting Value]
Set a value to be written to the specified word device.
The setting is required when [Mode] is set to [Custom].
• [Constant]:

Set a constant for the specified word device.
The setting range depends on the setting of [Data Type].

• [Indirect Device]:
Set an indirect device for the specified word device.
➟6.1.2 How to set devices
When [Constant] and [Indirect Device] are both selected, the value [Constant] + [Indirect Device] 
is written into the word device.

• [Variation]
Set this item when [Mode] is set to [Data Addition] or [Data Subtraction].
The setting range depends on the setting of [Data Type].
When [Mode] is set to [Data Addition], touching the word switch adds the set value to the value 
stored in the specified word device.
When [Mode] is set to [Data Subtraction], touching the word switch subtracts the set value from 
the value stored in the specified word device.

Item Description

When [Mode] is set to [Custom]

When [Mode] is set to [Data Addition] 

or [Data Subtraction]
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[Word] button

• [Initial Value Condition]
When the value in the specified word device satisfies the value set in [Condition Value], the value 
set in [Reset] is written to the device.
When [Mode] is set to [Custom], select both [Constant] and [Indirect Device] to enable this setting.
• [Condition Value]:

Set a condition value that is a trigger to write [Reset Value] to the specified word device.
The setting range depends on the setting of [Data Type].

• [Reset Value]:
Set a value to be written to the specified device when the value in the device satisfies the value 
set in [Condition Value].
The setting range depends on the setting of [Data Type].

[Extend] button

Sets a switching action, to screens such as the utility screen and the extended function screen, on 
a switch in the [Action (SP Function)] dialog.
For the setting of switch actions and applicable models, refer to the following.

➟8.2.9 [Special Function Switch] dialog

Item Description
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[Screen Switching] button

Sets the screen switching function for the switch in the [Action (Screen Switching)] dialog.

➟8.2.7 [Go To Screen Switch] dialog

• [Screen Type]
Select the type of the screen to be switched to.
The selectable items vary with the screen type.
The following shows the selectable items for a base screen or window screen.
• [Base]
• [Overlap Window1]
• [Overlap Window2]
• [Overlap Window3] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Overlap Window4] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Overlap Window5] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Superimpose Window1]
• [Superimpose Window2]
• [Dialog Window]
The following shows the selectable items for a mobile screen.
• [Mobile]
• [Overlap Window1]
• [Overlap Window2]
• [Superimpose Window1]
• [Superimpose Window2]
For [Overlap Window1] to [Overlap Window5], [Superimpose Window1], and [Superimpose 
Window2], the following setting is applicable.
If [Close the window when switching base screens] is selected in [Screen Switching/Window] in 
the [Environmental Setting] dialog, [(*)] is appended to the name of the target screen type.

• [Next Screen]
Select an action for screen switching.
• [Fixed]:

Select this item to switch to the screen having the specified base screen number or window 
screen number.
After selecting this item, set the base screen number or the window screen number.
Clicking the [Fixed] button displays the [Image List(Screen)] dialog. Check the screen image on 
the dialog before setting.

• [Back (Previous/History)]:
Select this item to switch to the screen having the base screen number previously displayed.
You can select this item only when the screen type is the base screen.
The GOT stores the numbers of the previously displayed base screens. A maximum of 10 
previous screens can be selected from the history.

• [Device]:
Select this item to switch to the base screen or the window screen having the specified screen 
number according to the on or off status or the current value of the specified device.
Before specifying the device, select the data type of the device to be monitored. (Bit, Signed 16-
bit binary data, or BCD16)
After specifying the device, click the [Detail Setting] button and configure the action settings.

• [Screen No.]
Specify the screen number of the target screen to be switched.
The setting range is [-1] to [32767].
You can set this item only when the screen type is the base screen.

Item Description
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[Station No. Switching] button

Sets the station No. switching function for the switch in the [Action (Station No. Switching)] dialog.
➟8.2.8 [Change Station No. Switch] dialog

• [Next Screen]
Select an action for station No. switching.
• [Host]:

Select this item to monitor the station connected with the GOT.
• [Other]:

Select this item to switch the monitor target to another station.
Set the destination network No. in [Net No.] and the station No. in [Station No.] in decimal.

• [Device]:
Select this item to switch to another station according to the on or off status or the current value 
of the specified device.
Before specifying the device, select the data type of the device to be monitored. (Bit, Signed 16-
bit binary data, or BCD16)
After specifying the device, click the [Detail Setting] button and configure the action settings.

• [Switching Mode]
Set the target for switching.
• [Project]:

Select this item to switch the whole project by the station number.
• [Screen Type]:

Select this item to switch only the specified screen by the station number.
When selecting [Screen Type], set the following.

• [Screen Type]:
Select the screen to be switched to.

Item Description
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[Key Code] button

Sets key codes to be input into the object in the [Action (Key Code)] dialog.
➟8.2.11 [Key Code Switch] dialog

• [Key Code Type]
Specify the key code type.
• [Numerical/Text Input]:

Inputs a key code for the numerical input or text input.
• [Alarm Display]:

Inputs a key code for the alarm display (user), alarm display (system), or simple alarm display.
➟9.1.5 Viewing alarm events (Alarm display)
8.12.2 How to use the simple alarm display

• [Recipe Display (Record List)]:
Inputs a key code for the recipe display (record list).
➟8.14.1 Specifications of the recipe display (record list)

• [Historical Trend Graph/Historical Data List]:
Inputs a key code for the historical trend graph or historical data list display.
➟8.21.1 Specifications of the historical trend graph

• [Document Display]:
Inputs a key code for the document display.
➟8.26.3 How to use the document display (for Document Converter output files)

• [Screen Gesture]:
Inputs a key code for the screen gesture.

For a single switch, only one of the above key code types can be set.
• [Individually set user ID for key input]

Set the user ID for the object on which the cursor is displayed when you touch the key code switch.
The setting range is [0] to [65535].
If no object with the set user ID exists, a cursor is displayed on an object with the earliest object ID 
number.

• [Code Setting]
• [Number/Character]

Select this item to input numeric values or characters using the key code.
Select an item for [Character Code], enter a numerical value or character in the selected 
character code, and click the [Convert to Key Code] button. The entered value or character is 
automatically converted to its key code.
The following shows the items to be selected for [Character Code].
· [ASCII]
· [Unicode]
· [S-JIS]
· [GB]
· [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
· [Big5]
· [Not specify]
When [Not specify] is selected for [Character Code], no character code conversion is executed 
and the key code switch operates using the character code set in the linked text input.

• [Action]:
Select this item to set an action by the key code.

Item Description
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[Key Code] button

• Specifying multiple key codes
Multiple key codes can be set to one switch. Setting multiple key codes can create the switch that 
the character string can be input with a single touch of the switch.

When you arrange the switch, to which multiple key codes are set, on a user-created key window, 
only the first key code can be executed.
When multiple key codes are entered for alarms, only the first key code can be executed.

• Reading or writing order for character code
The reading or writing order of the character codes set in the switch can be selected according to 
the specifications of a controller to be monitored.
➟8.5 Placing a Text Display and Text Input

[Key Window Display] button

Sets the key window display for the switch in the [Action (Key Window Display)] dialog.
➟8.2.10 [Key Window Display Switch] dialog

• [Key Window Position]
Specify the position (top-left coordinate) where the key window is displayed.
The maximum settable value is one dot smaller than the vertical or horizontal size of the GOT 
screen.
• [X]: Specify the coordinate value of the X axis.
• [Y]: Specify the coordinate value of the Y axis.

• Specifying objects for the key window display and setting the key window
The display target is the objects having the same user ID as the one specified in [User ID for a 
key input and data change] in the [Action] tab.
The key window is displayed that is set in the key window setting for the corresponding project 
or screen unit.
➟8.2.10 [Key Window Display Switch] dialog

Item Description

004D: M
0049: I
0054: T
0053: S
0055: U
0042: B
0049: I
0053: S
0048: H
0049: I
0000: (Settle)
Input "MITSUBISHI" at a time.

MITSUBISHI

X-coordinate

Y-coordinate
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3) [Utilize] button
Select an action to be utilized from [Action List] and then click the [Utilize] button, the selected action is copied and 
added to [Action List].

4) [Edit] button
Select an action to be edited from [Action List] and then click the [Edit] button, the set action is edited.

5) [Delete] button
Select an action to be deleted from [Action List] and then click the [Delete] button, the set action is deleted.

6) [User ID for a key input]
To operate the alarm or historical trend graph by the key code, set the ID to specify the object for the key code input.
The setting range is [0] to [65535].
Set [User ID for a key input] of the switch and [User ID] of each object to be the same.

7) [Change Order] button

[Sound Output] button

Not available to GT2505-V and GT25HS-V.
Set the sound output function for the switch in the [Action (Sound Output)] dialog.

• [Action Type]
Select an action of the sound output.
The following shows the items to be selected.
· [Play]
· [Stop]
· [Mute]

• [File No.]
Set this item when selecting [Play] for [Action Type].
Set the sound file to play.
The following shows the items to be selected.
· [Fixed]:

Select this item to specify a sound file number.
After selecting this item, specify the file number of a registered sound file in the [Sound File List] 
dialog.
The setting range is [1] to [500].

· [Device]
Select this item to specify a sound file number with the value of a specified device.
After selecting this item, specify a device.

• [Detail Setting]
Set this item when selecting [Stop] or [Mute] for [Action Type].
The following shows the items to be selected.
· [Stop currently playing sound]:

Stops the current playback.
The standby sound file plays subsequently.

· [Stop all sound]:
Stops the current playback and cancels all standby sound files.

· [Mute]
· [Unmute]
· [Mute/unmute]

Item Description

When [Play] is selected for [Action Type]

When [Stop] is selected for 
[Action Type]

When [Mute] is selected for 
[Action Type]

Set the same value.

Switch setting and alarm setting
8. OBJECT FUNCTION
8.2 Placing a Touch Switch

8 - 49



Changes the action order in the [Change Order] dialog.

8) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

• Switching the touch switch image according to the status of the corresponding device
Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

• [Order of Action]
The actions are executed in the order from the top.
The key code is executed first. Therefore the action order cannot be 
changed.
You can change the order of the third and subsequent actions.
• [Up] button:

Places the order of the selected action to one earlier.
• [Down] button:

Places the order of the selected action to one later.
• [Set as Default] button:

Sets the order changed by the [Up] button or the [Down] button as 
the default.
(This item cannot be used if an operation panel is set.)

• [Reset Default] button:
Returns the order changed by the [Up] button or [Down] button to 
the default.
(This item cannot be used if the operation panel is set.)

Item Description

[Key Touch State]
The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]
When the bit device set in [Device] turns on, the shape of the lamp off status is switched to the shape 
of the lamp on status. After selecting this item, set the device.
➟6.1.2 How to set devices

RUN

The shape of on status is displayed
while you touch the touch switch.

M100
ON

The shape of off status is displayed 
regardless of the device status while 
you do not touch the touch switch.

RUN

M100
ON

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
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9) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

10) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the shape of the 
lamp off status is switched to the shape of the lamp on status. After selecting this item, set the 
followings.
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the switching 
range between the shape of the lamp on status and the shape of the lamp off status.

➟6.2.2 Setting Trigger Types

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is selected)

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is not selected)

When [Key Touch State] is selected for 

[Lamp (Timing to change shape/text)]

1)

2)

3)

5)

4)

6)

When [None] is selected for [Shape]
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1) [Change a shape based on the key touch state]
This item is available when [Bit-ON/OFF] or [Word Range] is selected for [Lamp (Timing to change shape/text)].
You can set four different images using the lamp on and lamp off status in combination with the key touch on and 
key touch off status.
According to the key touch on and key touch off status, the shape can be switched. However, the text cannot be 
switched.
The following shows an example of the combination of image switching by the device status with shape switching 
by key touch status.

2) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extend] tab. The status of 
when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extend] tab.

3) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

4) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

6) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

RUN

RUN

M100
ON

RUN

M100
ON

(1) While M100 is off
      and you do not touch the touch switch

Key touch
OFF

STOP

RUN

Lamp 
OFF

Lamp
ON

Key touch
ON

M100
OFF

(2) While M100 is off
      and you touch the touch switch

(3) While M100 is on
      and you do not touch the touch switch

(4) While M100 is on
      and you touch the touch switch

M100
OFF

STOP

STOP

STOP

STOP

RUN

Preview list
The touch switch images set
in the [Style] tab and [Text] tab are displayed.

GOT Graphic Ver.1
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

[Blink]

Select the blinking speed of the touch switch.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
8. OBJECT FUNCTION
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1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set a range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

1)

3)
4)

2)

5)

6)
8 - 54 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set a vertical or horizontal position of the text.

[Offset to Frame]

Set an offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set a space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)

4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.
• When only [Device] is set

The comment of the same number as the value of [Device] is displayed regardless of 
the lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
8 - 58 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [User ID]
Select this item to set a user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

4) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)

6)

7)
8)

9)
10) 11)
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For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

5) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
6) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
8) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.

• [To Style tab] button: Displays the [Style] tab.
Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
• [To Text tab] button: Displays the [Text] tab.

Set the text displayed when the touch switch does not function.
➟8.2.4 ■3 [Text] tab

9) [KANJI Region]
Select a KANJI region of the displayed text.

➟1.2.5 Font specifications
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
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• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

10) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

11) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
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4) [Repeat the operation while the switch is pressed]
Select this item to allow the switch to repeat the same operation while you touch the touch switch.
For operations for which [Repeat the operation while the switch is pressed] can be set, refer to the following.

➟8.2.3 Precautions for a touch switch

■6 [Script] tab

For the settings of scripts, refer to the following.
➟9.8 Controlling Operations with Scripts ([Script])

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Item Description

[Start Delay] Set the time period from when you touch the touch switch to when the operation repeat 
starts. The setting range is [1] to [20].

[Cycle Period] Set the cycle for the operation repeat.
The setting range is [1] to [10].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

[Extended]

[Security Level] (display) security ○ ○ When the object is 
updated

When the screen is 
updated

[Security Level] (input) input_security ○ ○ Upon the setting change

[Delay] delay ○ ○ When the screen is updated

[Buzzer](One Shot, During 
Push) beep ○ ○ Upon the setting change

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)
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8.2.5 [Bit Switch] dialog

A bit switch turns on and off a bit device.
Step 1 Select [Object]→[Switch]→[Bit Switch] from the menu.
Step 2 Click the position where you arrange the bit switch.
Step 3 Double-click the arranged bit switch to display the setting dialog.

➟■1 [Device] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Device] tab

1) [Switch Action]

2) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Device]
Set the bit device to which the value is written.
➟6.1.2 How to set devices

[Action]

Select the function to be performed for the bit device as the destination when you touch the 
switch.
• [Momentary]: Keeps the bit device on only while you touch the switch.
• [Alternate]: Switches the on or off status of the bit device every time you touch the switch.
• [Set]: Turns on the bit device when you touch the switch.
• [Reset]: Turns off the bit device when you touch the switch.

[Add] button
Adds actions to the bit switch.
➟8.2.4 ■1 [Action] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
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• Switching the touch switch image according to the status of the corresponding device
Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

3) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

4) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

Item Description

[Key Touch State] The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]
When the bit device set in [Device] turns on, the shape of the lamp off status is switched 
to the shape of the lamp on status. After selecting this item, set the device.
➟6.1.2 How to set devices

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the 
shape of the lamp off status is switched to the shape of the lamp on status. After selecting 
this item, set the followings.
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the 
switching range between the shape of the lamp on status and the shape of the lamp off 
status.

➟6.2.2 Setting Trigger Types

RUN

The shape of on status
is displayed while you touch the touch switch.

M100
ON

The shape of off status
is displayed regardless of the device status
while you do not touch the touch switch.

RUN

M100
ON

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
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Touch switch action with the bit momentary
(1) The bit device remains on.

If the following events occur while you touch the touch switch for which the bit momentary is set, the bit 
device may remain on even after you release the finger from the switch.

• Hardware failure of the GOT
• Power-off of the GOT
• Communication error with controllers

As appropriate, set the timeout period of the on-status duration for the bit device, and set the operating 
condition so that the controller forcibly turns off the bit device in the case of the timeout.

(2) Switching to the base screen or window screen
If the base screen switching is requested while you touch the touch switch for which the bit momentary is 
set, the currently displayed base screen is switched to another base screen or window screen when you 
release the finger from the switch.

(3) When the operating condition of a touch switch being touched becomes unsatisfied
If the following cases occur while a touch switch is being touched, the set bit device turns off upon releasing 
the switch.

• The touch switch operating condition specified using [Operating Condition] becomes unsatisfied.
• The touch switch operating condition specified using [Control displaying/hiding] becomes unsatisfied.

(4) When the operating condition of a touch switch is unsatisfied
While the set device of a touch switch is on, if you touch the switch when its operating condition is 
unsatisfied, the device turns off upon touching the switch.
(Even if you select [Clear the input object] in the [Environmental Setting] window or the [Screen Property] 
dialog, touching the location of the hidden switch turns off the device.)
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Change a shape based on the key touch state]
This item is available when [Bit-ON/OFF] or [Word Range] is selected for [Lamp (Timing to change shape/text)].
You can set four different images using the lamp on and lamp off status in combination with the key touch on and 
key touch off status.
According to the key touch on and key touch off status, the shape can be switched. However, the text cannot be 
switched.
The following shows an example of the combination of image switching by the device status with shape switching 
by key touch status.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is selected)

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is not selected)

When [Key Touch State] is selected for 

[Lamp (Timing to change shape/text)]

1)

2)

3)

5)

4)

6)

When [None] is selected for [Shape]
8 - 68 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

2) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

3) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

4) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

6) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

RUN

RUN

M100
ON

RUN

M100
ON

(1) While M100 is off
      and you do not touch the touch switch

Key touch
OFF

STOP

RUN

Lamp
OFF

Lamp
ON

Key touch
ON

M100
OFF

(2) While M100 is off
     and you touch the touch switch

(3) While M100 is on 
     and you do not touch the touch switch

(4) While M100 is on
      and you touch the touch switch

M100
OFF

STOP

STOP

STOP

STOP

RUN

Preview list
The touch switch images set
in the [Style] tab and [Text] tab are displayed.

GOT Graphic Ver.1

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Blink]

Select the blinking speed of the touch switch.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)

4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)
4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.
• When only [Device] is set

The comment of the same number as the value of [Device] is displayed regardless of 
the lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [User ID]
Select this item to set a user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

4) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)

6)

7)
8)

9)
10) 11)
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For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

5) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
6) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
8) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
9) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
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• [Outline] (GT2107-W and GS21-W-N)
10) [Layer]

Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

11) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
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■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types
4) [Repeat the operation while the switch is pressed]

Select this item to allow the switch to repeat the same operation while you touch the touch switch.
For operations for which [Repeat the operation while the switch is pressed] can be set, refer to the following.

➟8.2.3 Precautions for a touch switch

Item Description

[Start Delay] Set the time period from when you touch the touch switch to when the operation repeat 
starts. The setting range is [1] to [20].

[Cycle Period] Set the cycle for the operation repeat.
The setting range is [1] to [10].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
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8.2.6 [Word Switch] dialog

A word switch changes the value of a word device.
Step 1 Select [Object] → [Switch] → [Word Switch] from the menu.
Step 2 Click the position where you arrange the word switch.
Step 3 Double-click the arranged word switch to display the setting dialog.

➟■1 [Device] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Device] tab

1) [Switch Action]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Device]
Set the word device to which a value is written.

➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Mode] is set to [Custom]

When [Mode] is set to [Data Addition] or [Data Subtraction]

1)

2)

4)3)
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2) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

• Switching the touch switch image according to the status of the corresponding device

[Data Type]

Select the data type for the values set in [Setting Value].
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Mode]

Set the writing mode for the specified word device.
• [Data Addition]: Select this item to add the value set in [Variation] to the value stored in 

the specified word device.
• [Data Subtraction]: Select this item to subtract the value set in [Variation] from the value 

stored in the specified word device.
• [Custom]: Select this item to write the value set in [Setting Value] to the specified word 

device.

[Variation]

Set this item when [Mode] is set to [Data Addition] or [Data Subtraction].
The setting range depends on the setting of [Data Type].
When [Mode] is set to [Data Addition], touching the word switch adds the set value to the 
value stored in the specified word device.
When [Mode] is set to [Data Subtraction], touching the word switch subtracts the set value 
from the value stored in the specified word device.

[Setting Value]

Set the value to be written to the specified word device.
The setting is required when [Mode] is set to [Custom].
• [Constant]: Set the constant for the specified word device.

The setting range depends on the setting of [Data Type].
• [Indirect Device]: Set the indirect device for the specified word device.

➟6.1.2 How to set devices
When [Constant] and [Indirect Device] are both selected, the value [Constant] + [Indirect 
Device] is written into the word device.

[Initial Value Condition]

When the value in the specified word device satisfies the value set in [Condition Value], the 
value set in [Reset] is written to the device.
When [Mode] is set to [Custom], select both [Constant] and [Indirect Device] to enable this 
setting.
• [Condition Value]: 

Set the condition value that is the trigger to write [Reset Value] to the specified word 
device.
The setting range depends on the setting of [Data Type].

• [Reset Value]: 
Set a value to be written to the specified device when the value in the device satisfies the 
value set in [Condition Value].
The setting range depends on the setting of [Data Type].

[Add] button
Adds actions to the word switch.

➟8.2.4 ■1 [Action] tab

Item Description

RUN

The shape of on status
is displayed while you touch the touch switch.

M100
ON

The shape of off status
is displayed regardless of the device status
while you do not touch the touch switch.

RUN

M100
ON
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Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

3) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

4) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

Item Description

[Key Touch State]
The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]

When the bit device set in [Device] turns on, the shape of the lamp off status is switched 
to the shape of the lamp on status.
After selecting this item, set the device.

➟6.1.2 How to set devices

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the 
shape of the lamp off status is switched to the shape of the lamp on status.
After selecting this item, set the followings.
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the 
switching range between the shape of the lamp on status and the shape of the lamp off 
status.

➟6.2.2 Setting Trigger Types

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Change a shape based on the key touch state]
This item is available when [Bit-ON/OFF] or [Word Range] is selected for [Lamp (Timing to change shape/text)].
You can set four different images using the lamp on and lamp off status in combination with the key touch on and 
key touch off status.
According to the key touch on and key touch off status, the shape can be switched. However, the text cannot be 
switched.
The following shows an example of the combination of image switching by the device status with shape switching 
by key touch status.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is selected)

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is not selected)

When [Key Touch State] is selected for 

[Lamp (Timing to change shape/text)]

1)

2)

3)

5)

4)

6)

When [None] is selected for [Shape]
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2) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

3) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

4) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

6) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

RUN

RUN

M100
ON

RUN

M100
ON

(1) While M100 is off
      and you do not touch the touch switch

Key touch
OFF

STOP

RUN

Lamp
OFF

Lamp
ON

Key touch
ON

M100
OFF

(2) While M100 is off
      and you touch the touch switch

(3) While M100 is on
      and you do not touch the touch switch

(4) While M100 is on
      and you touch the touch switch

M100
OFF

STOP

STOP

STOP

STOP

RUN

Preview list
The touch switch images set
in the [Style] tab and [Text] tab are displayed.

GOT Graphic Ver.1

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Blink]

Select the blinking speed of the touch switch.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)
4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)
4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.
• When only [Device] is set

The comment of the same number as the value of [Device] is displayed regardless of 
the lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

• [Solid Color]
When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

4) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
5)

6)

7)
8)

9)
10) 11)
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For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

5) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
6) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
8) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
9) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
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• [Outline] (GT2107-W and GS21-W-N)
10) [Layer]

Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

11) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
8. OBJECT FUNCTION
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■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types
4) [Repeat the operation while the switch is pressed]

Select this item to allow the switch to repeat the same operation while you touch the touch switch.
For operations for which [Repeat the operation while the switch is pressed] can be set, refer to the following.

➟8.2.3 Precautions for a touch switch

Item Description

[Start Delay] Set the time period from when you touch the touch switch to when the operation repeat 
starts. The setting range is [1] to [20].

[Cycle Period] Set the cycle for the operation repeat.
The setting range is [1] to [10].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
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8.2.7 [Go To Screen Switch] dialog

A Go To Screen switch switches base screens and window screens.
Step 1 Select [Object]→[Switch]→[Go To Screen Switch] from the menu.
Step 2 Click the position where you arrange the Go To Screen switch.
Step 3 Double-click the arranged Go To Screen switch to display the setting dialog.

➟■1 [Next Screen] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Next Screen] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)3)
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1) [Switch Action]

Item Description

[Screen Type]

Select the type of the screen to be switched to.
The selectable items vary with the screen type.
The following shows the selectable items for a base screen or window screen.
• [Base Screen]
• [Overlap Window1]
• [Overlap Window2]
• [Overlap Window3]
• [Overlap Window4]
• [Overlap Window5]
• [Superimpose Window1]
• [Superimpose Window2]
• [Dialog Window]
The following shows the selectable items for a mobile screen.
• [Mobile]
• [Overlap Window1]
• [Overlap Window2]
• [Superimpose Window1]
• [Superimpose Window2]
In either of the following cases, [(*)] is appended to the item selected for [Screen Type].
• [Close the window when switching base screens] is selected in the [Environmental 

Setting] window ([Screen Switching/Window]).
• [Close the window when switching mobile screens] is selected in the [GOT Mobile 

Setting] window ([Screen Switching/Window]).

[Next Screen]

Select an action for screen switching.
• [Fixed]:

Select this item to switch to the screen having the specified base screen number or 
window screen number.
After selecting this item, set the number of the base screen or window screen as the 
destination screen in [Screen No.].
Clicking the [Browse] button displays the [Image List(Screen)] dialog. Check the screen 
image on the dialog before setting.

• [Back (Previous/History)]:
Select this item to switch to the screen having the base screen number previously 
displayed.
You can select this item only when the screen type is the base screen.
The GOT stores the numbers of the previously displayed base screens. A maximum of 
10 previous screens can be selected from the history.

• [Device]:
Select this item to switch to the base screen or window screen having the specified 
screen number according to the on status, off status, or the current value of the specified 
device.
After selecting [Data Type], specify [Device].
After specifying [Device], click the [Detail Setting] button and configure the action settings 
for screen switching.

Bit device

• [ON/OFF]
• [No.]: 

Select this item to switch to the base screen or window screen having the specified 
screen number according to the on or off status of the specified bit device. 
Set the destination screen number.

• [Hold]: 
Select this item so as not to switch the screens when the specified bit device is on or off.
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[Next Screen]

Word device

• Preview list
Displays set conditions.

• Add button
Adds a new condition.

• Delete button
Deletes a selected condition.

• Up button, down button
Changes the order of priority of the selected condition.

• [Utilize] button
Creates a new condition utilizing the selected condition.

• [Exp] button
Set the range of the word device value for screen switching using a conditional 
expression.

• [Switching Type]
• [No.]:

If the value of the specified word device satisfies the set conditional expression, the 
screen switches to the base screen or window screen having the specified screen 
number. Set the destination screen number in the spin box. [Clicking the [Browse] 
button displays the [Image List(Screen)] dialog. Check the image on the window, and 
set it as the screen image.

• [Indirect Device]:
If the value of the specified word device satisfies the set conditional expression, the 
screen switches to the screen having the number equal to the value of the word device.

• [Hold]:
Even if the value of the specified word device satisfies the set conditional expression, 
the screens are not switched.

Switching screens with a sequence program
In the sequence program, the value of the destination screen number is written as the 
value of the screen switching device. Base screens and window screens can be switched 
without using the screen switching function of the touch switch.

However, if the screen switching device for the base screen or window screen is the GOT 
internal device (GB, GD, GS), the screens cannot be switched with the sequence program.

[Screen No.] Specify the screen number for the destination screen.
You can set this item only when the screen type is the base screen.

[Add] button
Adds actions to the switch.
➟8.2.4 ■1 [Action] tab

Item Description

Preview list

Down button

[Delete] button
Add button

Up button

M0
M0VP K10 D100 M0VP K10 D100

M0

Base screen No. 1 Base screen No. 10
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2) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

• Switching the touch switch image according to the status of the corresponding device
Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

Item Description

[Key Touch State] The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]
When the bit device set in [Device] turns on, the shape of the lamp off status is switched 
to the shape of the lamp on status. After selecting this item, set the device.
➟6.1.2 How to set devices

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the 
shape of the lamp off status is switched to the shape of the lamp on status. After selecting 
this item, set the followings.
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the 
switching range between the shape of the lamp on status and the shape of the lamp off 
status.

➟6.2.2 Setting Trigger Types

RUN

The shape of on status
is displayed while you touch the touch switch.

M100
ON

The shape of off status
is displayed regardless of the device status
while you do not touch the touch switch.

RUN

M100
ON

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
8 - 100 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

3) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

4) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Change a shape based on the key touch state]
This item is available when [Bit-ON/OFF] or [Word Range] is selected for [Lamp (Timing to change shape/text)].
You can set four different images using the lamp on and lamp off status in combination with the key touch on and 
key touch off status.
According to the key touch on and key touch off status, the shape can be switched. However, the text cannot be 
switched.
The following shows an example of the combination of image switching by the device status with shape switching 
by key touch status.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is selected)

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is not selected)

When [Key Touch State] is selected for 

[Lamp (Timing to change shape/text)]

1)

2)

3)

5)

4)

6)

When [None] is selected for [Shape]
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2) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

3) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

4) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

6) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

RUN

RUN

M100
ON

RUN

M100
ON

(1) While M100 is off
     and you do not touch the touch switch

Key touch
OFF

STOP

RUN

Lamp
OFF

Lamp
ON

Key touch
ON

M100
OFF

(2) While M100 is off
      and you touch the touch switch

(3) While M100 is on
     and you do not touch the touch switch

(4) While M100 is on
      and you touch the touch switch

M100
OFF

STOP

STOP

STOP

STOP

RUN

Preview list
The touch switch images set
in the [Style] tab and [Text] tab are displayed.

GOT Graphic Ver.1

Pattern + Shape color

Background color

Example)

Background color:
Pattern:
Shape color:
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Blink]

Select the blinking speed of the touch switch.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)

4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

CenterLeft Right

Down
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)

4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
8. OBJECT FUNCTION
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices

This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.

➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.

• When only [Device] is set
The comment of the same number as the value of [Device] is displayed regardless of the 
lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.

➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

4) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

For the details, refer to the following.

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)

6)

7)
8)

9)
10) 11)
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➟8.2.2 ■4 Disabling the simultaneous press for a touch switch
5) [Delay]

Select the delay.
• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
6) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
8) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
9) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
8. OBJECT FUNCTION
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10) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

11) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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8.2.8 [Change Station No. Switch] dialog

The Change Station No. switch switches the device of the currently monitored object to the same device with another 
station number.

Step 1 Select [Object] → [Switch] → [Change Station No. Switch] from the menu.
Step 2 Click the position where you arrange the Change Station No. switch.
Step 3 Double-click the Change Station No. switch to display the setting dialog.

➟■1 [Next Station] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Next Station] tab

1) [Switch Action]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Next Screen]

Select an action for station No. switching.
• [Host]:

Select this item to monitor the station connected with the GOT.
• [Other]:

Select this item to switch the monitor target to another station.
Set the destination network No. in [Net No.] and the station No. in [Station No.] in decimal.

• [Device]:
Select this item to switch to the base screen or window screen having the specified 
screen number according to the on status, off status, or the current value of the specified 
device.
After selecting [Data Type], specify [Device]. After specifying [Device], click the [Detail 
Setting] button and configure the action settings for screen switching.*1*2

[Switching Mode]
• [Project]: Select this item to switch the whole project by the station number.
• [Screen Type]: Select this item to switch only the specified screen by the station number.

[Add] button
Adds actions to the switch.
➟8.2.4 ■1 [Action] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)3)
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*1 Bit device

*2 Word device

2) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

• [ON/OFF]
• [Host]:

Select this item to monitor the controller connected with the 
GOT according to the on or off status of the specified bit 
device.

• [Other]:
Select this item to switch the monitor target to another 
station according to the on or off status of the specified bit 
device.
Set the destination network No. in [Net No.] and the station 
No. in [Station No.] in decimal.

• [Hold]:
Select this item so as not to switch the monitor target 
according to the on or off status of the specified bit device.

• Preview list
Displays set conditions.

• Add button
Adds a new condition.

• Delete button
Deletes a selected condition.

• Up button, down button
Changes the order of priority of the 
selected condition.

• [Utilize] button
Creates a new condition utilizing the 
selected condition.

• [Exp] button
Set the range of the word device value for 
screen switching using a conditional 
expression.

• [Switching Type]
Select the switching type to switch the 
station number when the value of the 
specified word device satisfies the 
conditional expression set in [Exp].
➟6.1.2 How to set devices
• [Host]:

If the value of the specified word device 
satisfies the set conditional expression, 
the monitor target is the controller 
connected with the GOT.

• [Other]:
If the value of the specified word device 
satisfies the set conditional expression, 
the monitor target is switched to another 
station. Set the destination network 
number in [Net No.] and the station 
number in [Station No.] in decimal.

• [Indirect Device]:
If the value of the specified word device 
satisfies the set conditional expression, 
the monitor target is switched to the one 
having the number equal to the value of 
the word device.

• [Hold]:
Even if the value of the specified word 
device satisfies the set conditional 
expression, the monitor target is not 
switched.

Preview list

Down button

[Delete] button
Add button

Up button
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• Switching the touch switch image according to the status of the corresponding device
Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

3) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

4) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

Item Description

[Key Touch State] The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]
When the bit device set in [Device] turns on, the shape of the lamp off status is switched 
to the shape of the lamp on status. After selecting this item, set the device.
➟6.1.2 How to set devices

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the 
shape of the lamp off status is switched to the shape of the lamp on status. After selecting 
this item, set the followings.
➟6.1.2 How to set devices
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the 
switching range between the shape of the lamp on status and the shape of the lamp off 
status.

➟6.2.2 Setting Trigger Types

RUN

The shape of on status
is displayed while you touch the touch switch.

M100
ON

The shape of off status
is displayed regardless of the device status
while you do not touch the touch switch.

RUN

M100
ON

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
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■2 [Style] tab

1) [Change a shape based on the key touch state]
This item is available when [Bit-ON/OFF] or [Word Range] is selected for [Lamp (Timing to change shape/text)].
You can set four different images using the lamp on and lamp off status in combination with the key touch on and 
key touch off status.
According to the key touch on and key touch off status, the shape can be switched. However, the text cannot be 
switched.
The following shows an example of the combination of image switching by the device status with shape switching 
by key touch status.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is selected)

When [Bit-ON/OFF]/[Word Range] is selected for 

[Lamp (Timing to change shape/text)] 

([Change a shape based on the key touch state] is not selected)

When [Key Touch State] is selected for 

[Lamp (Timing to change shape/text)]

1)

2)

3)

5)

4)

6)

When [None] is selected for [Shape]
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2) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

3) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

4) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

6) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

RUN

RUN

M100
ON

RUN

M100
ON

(1) While M100 is off
      and you do not touch the touch switch

Key touch
OFF

STOP

RUN

Lamp
OFF

Lamp
ON

Key touch
ON

M100
OFF

(2) While M100 is off
      and you touch the touch switch

(3) While M100 is on
      and you do not touch the touch switch

(4) While M100 is on
      and you touch the touch switch

M100
OFF

STOP

STOP

STOP

STOP

RUN

Preview list
The touch switch images set
in the [Style] tab and [Text] tab are displayed.

GOT Graphic Ver.1

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:
8. OBJECT FUNCTION
8.2 Placing a Touch Switch

8 - 117



■3 [Text] tab

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Blink]

Select the blinking speed of the touch switch.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)
4)

2)

5)

6)
8. OBJECT FUNCTION
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)
4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.

• Number of characters:
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.

➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.

• When only [Device] is set
The comment of the same number as the value of [Device] is displayed regardless of the 
lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

4) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)

6)

7)
8)

9)
10) 11)
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5) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
6) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
8) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
9) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
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10) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

11) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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8.2.9 [Special Function Switch] dialog

The special function switch switches the screen to the utility screen, the extended function screen, or other screens.
Step 1 Select [Object] → [Switch] → [Special Function Switch] from the menu.
Step 2 Click the position where you arrange the special function switch.
Step 3 Double-click the arranged special function switch to display the setting dialog.

➟■1 [SP Function] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [SP Function] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Switch Action]

2) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

3) [Convert to Lamp] button
Converts the object type to the lamp.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Action]

Select the type of the extended function screen to be displayed.
For the setting range, refer to the following.
➟8.2.9 ■1 (1) Operation settings
Some functions are unavailable even those are set.
For details, refer to the following manuals.
➟GT SoftGOT2000 Version1 Operating Manual
GOT2000 Series User's Manual (Monitor)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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➟8.2.2 How to use touch switch

(1) Operation settings
The following shows selectable items.

Operation setting Description Supported model

[Utility] Displays the utility.

[Key Windows] Displays the key window used for the numerical input function and the text input 
function.

[Start Hard Copy]
Starts the hard copy function (starts collecting the screen data).
➟8.2.9 ■1 (2) (a) Setting for [Start Hard Copy]

[Abort Hard Copy] Aborts the hard copy function (aborts collecting the screen data).

[Test Window] Displays the window for the test function.

[PX Developer Function Call]
Starts PX Developer.
➟8.2.9 ■1 (2) (b) Setting for [PX Developer Function Call]

[GOT Basic Setting Menu] Displays the setup screen.

[Brightness Adjustment] Displays the intensity adjustment screen.

[Password (Security Level)]
Displays the security level change screen.
This setting is available only when the level authentication is selected.

➟2.13 Protecting a Project by Registering Users

[Time] Displays the time setting screen.

[Data Control] Displays the data control screen.

[Clean/Display Screen] Displays the screen for cleaning the GOT screen.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Multimedia]
Not available to GT2705-V.
Displays the multimedia screen.

➟8.2.9 ■1 (2) (c) Setting for [Multimedia]

[Display] Displays the [Display] screen of the utility.

[Operation] Displays the [Operation] screen of the utility.

[Language] Displays the [Language] screen of the utility.

[Controller] Displays the communication setting screen.

[PC Remote Operation (Ethernet)]
Displays the personal computer screen on the GOT.
➟8.2.9 ■1 (2) (g) Setting for [PC Remote Operation (Ethernet)]

[Monitor Menu] Displays the monitor menu screen.

[System Launcher]
Displays the system configuration screen of the system launcher.
➟8.2.9 ■1 (2) (d) Setting for [System Launcher]

[Device Monitor]
Displays the screen for the device monitor function.
➟8.2.9 ■1 (2) (e) Setting for [Device Monitor]

[Network Monitor]
Displays the network monitor screen.
➟8.2.9 ■1 (2) (f) Setting for [Network Monitor]

[Sequence Program Monitor (Ladder)]
Displays the sequence program monitor (ladder) screen.
➟8.2.9 ■1 (2) (h) Setting for [Sequence Program Monitor (Ladder)]

[Sequence Program Monitor (iQ-R/iQ-L 
Ladder)]

Displays the screen of the sequence program monitor (iQ-R/iQ-L ladder).
➟8.2.9 ■1 (2) (i) Setting for [Sequence Program Monitor (iQ-R/iQ-L Ladder)]

[Sequence Program Monitor (iQ-F 
Ladder)]

Displays the screen of the sequence program monitor (iQ-F ladder).

➟8.2.9 ■1 (2) (j) Setting for [Sequence Program Monitor (iQ-F Ladder)]

Operation setting Description Supported model

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Sequence Program Monitor(SFC)]
Displays the sequence program monitor (SFC) screen.
➟8.2.9 ■1 (2) (k) Setting for [Sequence Program Monitor (SFC)]

[R Motion SFC Monitor]
Displays the R motion SFC monitor screen.
➟8.2.9 ■1 (2) (l) Setting for [R Motion SFC Monitor]

[Q Motion SFC Monitor]
Displays the Q motion SFC monitor screen.
➟8.2.9 ■1 (2) (m) Setting for [Q Motion SFC Monitor]

[Log Viewer]
Displays the log viewer screen.
➟8.2.9 ■1 (2) (n) Setting for [Log Viewer]

[Intelligent Module Monitor]
Displays the intelligent module monitor screen.
➟8.2.9 ■1 (2) (o) Setting for [Intelligent Module Monitor]

[Servo Amplifier Monitor] Displays the servo amplifier monitor screen.

[R Motion Monitor]
Displays the R motion monitor screen.
➟8.2.9 ■1 (2) (p) Setting for [R Motion Monitor]

[Q Motion Monitor]
Displays the Q motion monitor screen.
➟8.2.9 ■1 (2) (q) Setting for [Q Motion Monitor]

[FX List Editor]
Displays the screen for the FX list editor function.
Not available to GT25-W and GT21-P.

[FX List Monitor]
Displays the FX list monitor screen.
Not available to GT25-W and GT21-P.

[FX Ladder Monitor] Displays the FX ladder monitor screen.

[CNC Monitor]
Displays the CNC monitor screen.
Available to GT27-X , GT27-S and GT25-S.

➟8.2.9 ■1 (2) (r) Setting for [CNC Monitor]

[CNC Data I/O]
Displays the CNC data I/O screen.
Available to GT27-X , GT27-S and GT25-S.

➟8.2.9 ■1 (2) (s) Setting for [CNC Data I/O]

Operation setting Description Supported model

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[CNC Machining Program Edit]
Displays the CNC machining program edit screen.
Available to GT27-X , GT27-S and GT25-S.

➟8.2.9 ■1 (2) (t) Setting for [CNC Manufacturing Program Editor]

[CNC Monitor 2]
Displays the CNC monitor 2 screen.
Not available to GT25-W, GT2505-V, and GT25HS-V.

➟8.2.9 ■1 (2) (u) Setting for [CNC Monitor 2]

[Motion Program Editor]
Displays the motion program editor screen.
Available to GT27-X, GT27-S, GT25-S, GT2512-WX, and GT2510-WX.

[Motion Program Input/Output]
Displays the motion program input/output screen.
Available to GT27-X, GT27-S, GT25-S, GT2512-WX, and GT2510-WX.

[iQSS Utility]
Displays the iQSS utility screen.
➟8.2.9 ■1 (2) (v) Setting for [iQSS Utility]

[Drive Recorder]
Displays the drive recorder screen.
➟8.2.9 ■1 (2) (w) Setting for [Drive Recorder]

[Servo Amp Graph]
Displays the servo amplifier graph screen.
➟8.2.9 ■1 (2) (x) Settings for [Servo Amp Graph]

[Backup/Restoration]
Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
Displays the screen for backup and restoration.

➟8.2.9 ■1 (2) (y) Setting for [Backup/Restoration]

[USB Device Control]
Only available to GT2107-W for GT21.
Displays the USB device control screen.

[CC-Link IE TSN/CC-Link IE Field 
Network diagnostics]

Displays the screen for the CC-Link IE TSN/CC-Link IE Field Network 
diagnostics.
➟8.2.9 ■1 (2) (z) Settings for [CC-Link IE TSN/CC-Link IE Field Network 
diagnostics]

[Vision Sensor Monitor] Displays the vision sensor monitor screen.

[Maintenance Menu] Displays the maintenance menu screen.

[Batch Self Check] Displays the self check result menu screen.

Operation setting Description Supported model

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Network Status Display] Displays the network status display screen.

[System Alarm Display] Displays the system alarms, and resets the GOT errors.

[Recipe Information]

Displays the recipe operation window when [Enable recipe file operation on the 
monitor] is selected in the [Recipe Common Setting] dialog.
Displays the recipe information when [Enable recipe file operation on the 
monitor] is deselected in the [Recipe Common Setting] dialog.

Displays the recipe information.

[Recipe Data Operation]
Imports or exports recipe data.
➟8.2.9 ■1 (2) (aa) Settings for [Recipe Data Operation]

[Logging Information] Displays the logging information.

[Operation Log Information]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Displays the operation log information.

[Operator Information Management]
Displays the operator information management screen when the operator 
authentication is enabled.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

[Operator Management]
Displays the operator management screen when the operator authentication is 
enabled.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

[Log-in/Log-out (Operator 
Authentication)]

Displays the login and logout screen when the operator authentication is 
enabled.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

[Password Change (Operator 
Authentication)]

Displays the password change screen when the operator authentication is 
enabled.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

[File Manager] Displays the file manager screen.

[File Print]
Displays the print file list display screen for the file print function.
➟(ab) Settings for [File Print]

Operation setting Description Supported model

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(2) Detail setting for the actions whose setting must be configured
(a) Setting for [Start Hard Copy]

Set the hard copy output destination.
Configure the setting of the selected output destination in the [Hard Copy] dialog.
Otherwise, the hard copy cannot be output.
For the details of the hard copy function, refer to the following.

➟9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard Copy])

(b) Setting for [PX Developer Function Call]
Set the PX Developer function to be called by interaction with GT SoftGOT2000.
For the interaction between GT SoftGOT2000 and PX Developer, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

• [Specify the destination to output hard copies]
• [Destination]

Set the hard copy output destination.
The following shows selectable items.
[File]
[Printer]

• [No.]
Set the number corresponding to the PX Developer function set in 
the [PX Developer Function Call Setting] dialog.

• [Browse] button
Set the PX Developer function to be called in the [PX Developer 
Function Call Setting] dialog.
For how to set the [PX Developer Function Call Setting] dialog, refer 
to the following manual.

➟GT SoftGOT2000 Version1 Operating Manual
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(c) Setting for [Multimedia]
Set the multimedia screen to be displayed.
For the details of the multimedia function, refer to the following.

➟10.8 Recording or Playing Images Taken by a Video Camera on the GOT (Multimedia Function)

(d) Setting for [System Launcher]
Set a controller connected when the system configuration screen of the system launcher is called up with a special 
function switch.
For the details of the system launcher function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Initial Display Screen]
Select the multimedia screen to be displayed when you touch the 
switch.
• [File Menu]: Select this item to display the file menu screen.
• [Video Image]: Select this item to display the video image screen.
• [Video Playback]: Select this item to display the video playback 

screen.
• [File Name]

Set the name and the extension (3GP or MP4) of the video file to be 
played.
Set them only when [Video Playback] is selected for [Initial Display 
Screen].
Set the file name with 70 alphanumeric characters or less.

• [Add date to playback files]
The device value set for [Playback File Time Specification Device] 
in the [Multimedia] dialog ([Playback/External Notification] tab) of 
[Peripheral Setting] is added to the name of the video file to be 
played as the date and time of recording.

• [To Multimedia] button
Displays the [Multimedia] dialog.
For how to set the [Multimedia] dialog, refer to the following.

➟10.8.6 [Multimedia] dialog

• [Specify the destination to connect the screen of System 
Configuration]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-L]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].
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(e) Setting for [Device Monitor]
Set a controller connected when the device monitor screen is called up with a special function switch.
For the details of the device monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

(f) Setting for [Network Monitor]
Set a controller connected when the network monitor screen is called up with a special function switch.
For the details of the network monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of Device Monitor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC iQ-R, RnMT/RT, CR800-D]
[MELSEC iQ-L]
[MELSEC iQ-F]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]
[MELSEC-QnA, MELDAS C6*]
[MELSEC-L]
[MELSEC-FX]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [Specify the destination to connect the screen of Network Monitor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-L]
[MELIPC]
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(g) Setting for [PC Remote Operation (Ethernet)]
Set the personal computer screen on the GOT to be displayed.
For the details of the remote personal computer operation function (Ethernet), refer to the following.

➟10.3 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation (Ethernet))

• [Window Display]
• [Window Size]

Set the display size of the personal computer screen on the GOT 
in the window display mode.
[X]: The setting range is [320] to [Horizontal resolution of GOT].
[Y]: The setting range is [240] to [Vertical resolution of GOT].

• [Window Position]
Select the display position of the personal computer screen on the 
GOT in the window display mode.
Set the top-left coordinate of the window position of the remote 
personal computer operation (Ethernet) in [Specified coordinates].
If the window is arranged beyond the screen, the coordinate is 
adjusted so that the whole window is displayed on the screen.

• [Window Title]
Select the title to be displayed in the title bar of the personal 
computer screen on the GOT.
The following shows the items to be selected.
[Standard]
[IP Address]
[Comment Group]
The following shows the details of each setting.
Select [Standard] to display [PC Remote Operation (Ethernet)].
Select [IP Address] to display the IP address of the connected 
personal computer.
Select [Comment Group] to display the comment with the 
specified comment number.
Click the [Edit] button to edit the comment with the specified 
comment number.

• [Display Magnification]:
Select the display magnification of the personal computer screen 
on the GOT. The following shows the items to be selected.
[100%]
[50%]
[33%]
[25%]

• [Operation Setting]
• [Enable GOT touch operation at the time of PC Remote Operation 
(Ethernet)]:

Select this item to enable the touch operation on the GOT while 
the personal computer screen is displayed.

• [Soft Keyboard]:
Select the soft keyboard type used in the personal computer 
screen from [Japanese 106 Keyboard] or [English 101 Keyboard].

• [VNC Server Setting]
• [IP Address]

Set the IP address of the VNCserver. The setting range is [0.0.0.0] 
to [255.255.255.255].

• [Password]:
Set the password for connection with the VNC server.
Set the password with 31 characters or less.
One-byte alphanumeric characters, one-byte space, and the 
following symbols are available for the password.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { ¦ } ̃

• [Port No.]
Set the port number for connection with the VNC server.
The setting range is [1024] to [65535]. Set the port number to 5923 
to use the terminal server.

• [Use Terminal Server Auto Logon]
Click the [Setting] button to display the [Use Terminal Server Auto 
Logon] dialog.
Set the user name and password to log on to the terminal server 
automatically.
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(h) Setting for [Sequence Program Monitor (Ladder)]
Set the ladder search method by the one-touch ladder jump function.
Before the ladder search setting, configure the following setting.

• Select [Common] → [GOT Setup] → [Advanced Setting] → [Sequence Program Monitor] from the menu.
• Select [Update the sequence program monitor setting], and then select [Automatically read out a sequence program] 

of [Display the operational state in a pop-up window].
➟5.3.10 ■1 [Sequence Program Monitor]

For the details of the sequence program monitor (ladder) function, refer to the following.
➟GOT2000 Series User's Manual (Monitor)

• [Use One-touch Ladder Jump]
• [Search Method]

Select the search method at the sequence program monitor 
(ladder) startup.
Select [Specify Search Device] to search for files and devices. 
Select [Specify Connected Station] to search for controllers and 
files.

• [Ladder Search Device]
When [Specify Search Device] is selected for [Search Method], 
set a device to be searched for at the sequence program monitor 
(ladder) startup.

➟6.1.2 How to set devices
• [Ladder Search Mode]

When [Specify Search Device] is selected for [Search Method], 
select the search mode from [Coil] or [Factor].
• [CH No.]:

When [Specify Connected Station] is selected for [Search 
Method], set a channel No. to be searched.
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-QnA, MELDAS C6*]
[MELSEC-L]
[MELSEC-A]
[MELSEC-FX]
[MELIPC]

• [Network]:
When [Specify Connected Station] is selected for [Search 
Method], set the controller to be searched.
Select [Host] to search for the controller of the host station.
Set the CPU No.
Select [Other] to search for the controller of another station.
Set the network No., PC station No., and the CPU No. of the 
station connected with the GOT.

• [Specify the search file]
Select this item to specify the name of the program file to be 
searched.
Up to 8 characters can be set for the file name.
A file whose name includes both two-byte and one-byte characters 
can also be searched for.

Select [Specify Search Device] for the search method.

Select [Specify Connected Station] for the search method.
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(i) Setting for [Sequence Program Monitor (iQ-R/iQ-L Ladder)]
Set the ladder search method by the one-touch ladder jump function.
Before the ladder search setting, configure the following setting.

• Select [Common] → [GOT Setup] → [Advanced Setting] → [Sequence Program Monitor] from the menu.
• Select [Update the sequence program monitor setting], and then select [Automatically read out a sequence program] 

of [Display the operational state in a pop-up window].
➟5.3.10 ■1 [Sequence Program Monitor]

For details on the sequence program monitor (iQ-R/iQ-L ladder) function, refer to the following.
➟GOT2000 Series User's Manual (Monitor)

• [Use One-touch Ladder Jump]
• [Search Method]

Select a search method used at the sequence program monitor 
(iQ-R/iQ-L ladder) startup.
Select [Specify Search Device] to search for files and devices.
Select [Specify Connected Station] to search for controllers and 
files.

• [Ladder Search Device]
When [Specify Search Device] is selected for [Search Method], 
set a device to be searched for at the sequence program monitor 
(iQ-R/iQ-L ladder) startup.
➟6.1.2 How to set devices

• [Ladder Search Mode]
When [Specify Search Device] is selected for [Search Method], 
select the search mode from [Coil] or [Factor].
• [CH No.]:

When [Specify Connected Station] is selected for [Search 
Method], set a channel No. to be searched.
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC iQ-L]
[MELIPC]

• [Network]:
When [Specify Connected Station] is selected for [Search 
Method], set the controller to be searched.
Select [Host] to search for the controller of the host station.
Set the CPU No.
Select [Other] to search for the controller of another station.
Set the network No., PC station No., and the CPU No. of the 
station connected with the GOT.

• [Specify the search file]
Select this item to specify the name of the program file to be 
searched.
A file whose name is up to 60 characters long can be searched for.
A file whose name includes both two-byte and one-byte 
characters can also be searched for.
A file whose name includes one-byte spaces or any symbol below 
cannot be searched for.
( " \ / ; : ? < > ¦ + = [ ] . , )

Select [Specify Search Device] for the search method.

Select [Specify Connected Station] for the search method.
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(j) Setting for [Sequence Program Monitor (iQ-F Ladder)]
Set the ladder search method by the one-touch ladder jump function.
Before the ladder search setting, configure the following setting.

• Select [Common] → [GOT Setup] → [Advanced Setting] → [Sequence Program Monitor] from the menu.
• Select [Update the sequence program monitor setting], and then select [Automatically read out a sequence program] 

of [Display the operational state in a pop-up window].
➟5.3.10 ■1 [Sequence Program Monitor]

For details on the sequence program monitor (iQ-F ladder) function, refer to the following.
➟GOT2000 Series User's Manual (Monitor)

• [Use One-touch Ladder Jump]
• [Search Method]

Select a search method used at the sequence program monitor 
(iQ-F ladder) startup.
Select [Specify Search Device] to search for files and devices.
Select [Specify Connected Station] to search for controllers and 
files.

• [Ladder Search Device]
When [Specify Search Device] is selected for [Search Method], 
set a device to be searched for at the sequence program monitor 
(iQ-F ladder) startup.
➟6.1.2 How to set devices

• [Ladder Search Mode]
When [Specify Search Device] is selected for [Search Method], 
select the search mode from [Coil] or [Factor].
• [CH No.]:

When [Specify Connected Station] is selected for [Search 
Method], set a channel No. to be searched.
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC iQ-L]
[MELIPC]
[MELSEC iQ-F]

• [Network]:
When [Specify Connected Station] is selected for [Search 
Method], set the controller to be searched.
Select [Host] to search for the controller of the host station.
Set the CPU No.
Select [Other] to search for the controller of another station.
Set the network No., PC station No., and the CPU No. of the 
station connected with the GOT.

• [Specify the search file]
Select this item to specify the name of the program file to be 
searched.
A file whose name is up to 60 characters long can be searched for.
A file whose name includes both two-byte and one-byte 
characters can also be searched for.
A file whose name includes one-byte spaces or any symbol below 
cannot be searched for.
( " \ / ; : ? < > ¦ + = [ ] . , )

Select [Specify Search Device] for the search method.

Select [Specify Connected Station] for the search method.
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(k) Setting for [Sequence Program Monitor (SFC)]
Configure the setting for the SFC program display on the block list screen or the SFC diagram monitor screen.
For the details of the sequence program monitor (SFC) function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Use Block List/SFC Diagram display function]
Select this item to set the SFC program displayed on the block list 
screen or the SFC diagram monitor screen at the sequence program 
monitor (SFC) startup.
• [Display Screen]

Select the screen displayed at the sequence program monitor 
(SFC) startup.
Select [Block List] to display the block list monitor screen. Select 
[SFC Diagram] to display the SFC diagram monitor screen.
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-QnA, MELDAS C6*]
[MELSEC-L]
[MELIPC]

• [Network]
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.
• [Net No.]:

When [Other] is selected for [Network], set the network No. of 
the controller to be monitored.
The setting range is [0] to [255].

• [Station No.]:
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [File Name]:
Specify the name of the SFC program file to be read from the 
controller.
Up to 8 characters can be set for the file name.

• [Block No.]:
When [SFC Diagram] is selected for [Display Screen], set the 
block No. of the block to be displayed at the SFC monitor 
startup.
The setting range is [0] to [319].
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(l) Setting for [R Motion SFC Monitor]
Configure the setting for the SFC program display by the program batch monitor window or the SFC diagram display 
function.
For details on the R motion SFC monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Use Program Batch Monitor Window/SFC Diagram display function]
Select this item to set the SFC program displayed on the program 
batch monitor window or the SFC diagram monitor screen at the R 
motion SFC monitor startup.
• [Display Screen]:

Select the screen type to be displayed at the R motion SFC 
monitor startup.
Select [Program Batch Monitor Window] to display the program 
batch monitor window. Select [SFC Diagram] to display the SFC 
diagram monitor screen.

• [CH No.]:
Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [PC Station No.]
When [Other] is selected for [Network], set the PC station No. of the 
controller to be monitored.
The setting range is [0] to [120].
• [CPU Machine]:

Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [File Name]:
Specify the name of the SFC program file to be read from the 
controller.
Up to 16 characters can be set for the file name.
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(m) Setting for [Q Motion SFC Monitor]
Configure the setting for the SFC program display by the program batch monitor window or the SFC diagram display 
function.
For details on the Q motion SFC monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

(n) Setting for [Log Viewer]
Set the initial screen and a controller connected when the log viewer is started with a special function switch.
For the details of the log viewer, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Use Program Batch Monitor Window/SFC Diagram display function]
Select this item to set the SFC program displayed on the program 
batch monitor window or the SFC diagram monitor screen at the Q 
motion SFC monitor startup.
• [Display Screen]:

Select the screen displayed at the Q motion SFC monitor startup.
Select [Program Batch Monitor Window] to display the program 
batch monitor window. Select [SFC Diagram] to display the SFC 
diagram monitor screen.

• [CH No.]:
Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [PC Station No.]
When [Other] is selected for [Network], set the PC station No. of the 
controller to be monitored.
The setting range is [0] to [120].
• [CPU Machine]:

Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [File Name]:
Specify the name of the SFC program file to be read from the 
controller.
Up to 16 characters can be set for the file name.

• [Initial Display Screen]
Select the initial screen to be displayed at the log viewer startup.
The following shows selectable items.
[Main Menu]
[File Selection Screen]

• [Specify the destination]
• [Type]

Select a controller.
The following shows selectable items.
[High Speed Data Logger/BOX Data Logger]
[RCPU/LHCPU]
[FX5CPU]
[QnUDV/LCPU]

• [IP Address]
Set the IP address of the controller.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].

• [Access Authentication]
• [User Name]

Set the user name for access authentication.
Up to 32 one-byte alphanumeric characters are settable.

• [Password]
Set the password for access authentication.
Up to 32 one-byte alphanumeric characters are settable.

• [Remote Password Authentication]
• [Password]

Set the password for remote password authentication.
Up to 32 one-byte alphanumeric characters are settable.
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(o) Setting for [Intelligent Module Monitor]
Set a controller connected when the intelligent module monitor is started with a special function switch.
For the details of the intelligent module monitor function, refer to the following manual.

➟GOT2000 Series User's Manual (Monitor)

(p) Setting for [R Motion Monitor]
Set a controller connected when the R motion monitor is started with a special function switch.
For the details of the R motion monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of Intelligent Module 
Monitor]
• [CH No.]:]

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-L]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]:
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [Specify the destination to connect the screen of R Motion Monitor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]:
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].
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(q) Setting for [Q Motion Monitor]
Set a controller connected when the Q motion monitor is started with a special function switch.
For the details of the Q motion monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

(r) Setting for [CNC Monitor]
Set the CNC connected when the CNC monitor is started with a special function switch.
For the details of the CNC monitor function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of Q Motion Monitor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [Specify the destination to connect the screen of CNC Monitor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].
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(s) Setting for [CNC Data I/O]
Set the CNC connected when the CNC data I/O screen is called up with a special function switch.
For the details of the CNC data I/O function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

(t) Setting for [CNC Manufacturing Program Editor]
Set the CNC connected when the CNC machining program edit screen is called up with a special function switch.
For the details of the CNC machining program edit function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of CNC Data Input/
Output]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be 
monitored.Select [Host] to monitor the controller of the host 
station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [Specify the destination to connect the screen of CNC Manufacturing 
Program Editor]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].
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(u) Setting for [CNC Monitor 2]
Set the screen display method and connection destination for the CNC monitor 2 that is started with a special function 
switch.
For the details of the CNC monitor 2, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Keyboard]
Available to GT27-S and GT25-S.
Select the type of the software keyboard to be displayed on the CNC 
monitor 2 screen.
• [Link to CNC]:

Switches between software keyboards according to the type of the 
connected CNC.

• [Not displayed]:
Hides the software keyboard.

• [M system]:
Displays the software keyboard applicable to machining centers.

• [L system]:
Displays the software keyboard applicable to lathes.

• [Specify the destination]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]: 
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [Specify the initial display screen]
Set the initial screen to be displayed at the startup of CNC monitor 2.
Specify a CNC screen name or screen number.
• [Display Screen]:

Select the name of the initial screen.
To use a screen number to specify the initial screen, select 
[Specify the screen No.].
The following shows the items to be selected.
[Monitor screen]
[Setup screen (Tool offset)]
[Edit screen]
[Diagnosis screen (System Configuration)]
[Alarm]
[Maintenance screen]
[Parameter]
[Input/Output (Maintenance screen)]
[Menu list]
[Specify the screen No.]

• [Screen No.]:
This item appears when [Specify the screen No.] is selected for 
[Display Screen].
Specify the screen number of the initial screen.
If the specified screen has a name, the screen name is displayed.

• [Specify the system No.]
Set the initial system to be displayed at the startup of CNC monitor 
2.

• [System No.]:
Specify the number of the initial system.
The setting range is [1] to [7].
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(v) Setting for [iQSS Utility]
Set a controller connected when the iQSS utility screen is called up with a special function switch.
For the details of the iQSS utility function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

To use the iQSS utility special control, select [Specify the destination to connect the screen of iQSS Utility], and set the 
sensor device number to [Name].
Set [<iQSS=n>] (sensor device number) to [Name].
You can set 0 to 65534 to "n".

(w) Setting for [Drive Recorder]
Set the screen display size and the connection destination for the drive recorder that is started with a special function 
switch.
For the details of the drive recorder, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of iQSS Utility]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-L]
[MELIPC]

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]:
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].
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• [Window Size]
This item is settable for GT27-X, GT27-S, GT25-W, GT25-S, GT 
SoftGOT2000 and GS25.
Set the window size of the graph waveform screen.
· [Adjust the size to the GOT resolution]: 

Adjusts the window size of the graph waveform screen to the GOT 
resolution.

· [Specify the size]:
Specify the window size directly.
The setting range depends on the GOT model.

• [Graph Waveform Size]
This item is settable for GT27-X, GT27-S, GT25-W, GT25-S, GT 
SoftGOT2000 and GS25.
Set the size of the graph display area on the graph waveform 
screen.
· [Adjust the size to the GOT resolution]:

Adjusts the graph display area size to the GOT resolution.
This item is selectable when [Specify the size] is selected for 
[Window Size].

· [Specify the size]:
Select the graph display area size.
The setting range depends on the GOT model.

• [Specify the destination]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of the 
controller to be monitored.
The setting range is [0] to [120].
• [Destination (Servo)]:

Select the controller through which a servo amplifier is monitored.
The following shows selectable items.
[None]
[Via Motion CPU]
[Via Simple Motion (SSCNET III/H)]
[Via Simple Motion (CC-Link IE Field Network)]
[Via CC-Link IE Field Network Communication Module]
[Via Motion Module(CC-Link IE TSN)]
To specify a controller upon startup of the drive recorder, select 
[None].

• [CPU Machine]:
Specify the CPU number of a Motion CPU through which a servo 
amplifier is monitored.
The setting range is [2] to [4].

• [First I/O]:
Specify the start I/O number of a Simple Motion module, CC-Link 
IE Field Network communication unit, or Motion module through 
which a servo amplifier is monitored.
The setting range varies with the controller.
When the controller is set to [MELSEC iQ-F] and [Network] is set 
to [Host], the setting range is [01] to [10].
In other cases, the setting range is [00] to [FF].

• [Target Axis No.]:
Specify the number of an axis from which data is read.
The setting range is [1] to [64].

• [Target Station No.]:
Specify the station number of a controller from which data is read.
The setting range is [0] to [120].

• [Target Axis Designation]:
Specify the axis from which data is read.
The following shows selectable items.
[1]: Single-axis/Axis A
[2]: Axis B
[3]: Axis C
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(x) Settings for [Servo Amp Graph]
Set the screen display size and the connection destination for the servo amplifier graph that is started with a special 
function switch.
For the details of the servo amplifier graph, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Window Size]
This item is settable for GT27-X, GT27-S, GT25-W, GT25-S, GT 
SoftGOT2000 and GS25.
Set the window size of the graph waveform screen.
• [Adjust the size to the GOT resolution]:

Adjusts the window size of the graph waveform screen to the GOT 
resolution.

• [Specify the size]:
Specify the window size directly.
The setting range depends on the GOT model.

• [Graph Waveform Size]
This item is settable for GT27-X, GT27-S, GT25-W, GT25-S, GT 
SoftGOT2000 and GS25.
Set the size of the graph display area on the graph waveform 
screen.
• [Adjust the size to the GOT resolution]:

Adjusts the graph display area size to the GOT resolution.
This item is selectable when [Specify the size] is selected for 
[Window Size].

• [Specify the size]:
Select the graph display area size.
The setting range depends on the GOT model.

• [Specify the destination]
• [CH No.]:

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].

• [Network]:
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]:
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of the 
controller to be monitored.
The setting range is [0] to [120].
• [Destination (Servo)]:

Select a controller through which a servo amplifier is monitored.
The following shows selectable items.
[None]
[Via Motion CPU]
[Via Simple Motion (SSCNET III/H)]
[Via Motion Module(CC-Link IE TSN)]
To connect the controller specified on the PLC side upon startup 
of the servo amplifier graph, select [None].
[Via Motion Module(CC-Link IE TSN)] is selectable for the 
channels for which [MELSEC iQ-R, RnMT/NC/RT, CR800-D] is 
selected for [Controller Type].

• [CPU Machine]:
Specify the CPU number of a Motion CPU through which a servo 
amplifier is monitored.
The setting range is [2] to [4].

• [First I/O]:
Specify the start I/O number of a Simple Motion module or Motion 
module through which a servo amplifier is monitored.
The setting range varies with the controller.
When the controller is set to [MELSEC iQ-F] and [Network] is set 
to [Host], the setting range is [01] to [10].
In other cases, the setting range is [00] to [FF].

• [Specify the file to be read at the time of startup]:
Specify a waveform data file (*.gpf2) to be read upon startup of the 
servo amplifier graph.

• [Setting] button:
Displays the [gpf2 File Setting] dialog.
Set [Drive Name], [Folder Name], and [File Name] to specify the 
path of the file to be read.
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(y) Setting for [Backup/Restoration]
Set a controller connected when the backup/restoration screen is called up with a special function switch.
For the details of the backup/restoration function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

(z) Settings for [CC-Link IE TSN/CC-Link IE Field Network diagnostics]
Set a controller connected when the screen for the CC-Link IE TSN/CC-Link IE Field Network diagnostics is called up 
with a special function switch.
For details on the CC-Link IE TSN/CC-Link IE Field Network diagnostics, refer to the following.

➟GOT2000 Series User's Manual (Monitor)

• [Specify the destination to connect the screen of Backup/
Restoration]
• [CH No.]:]

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC iQ-R, RnMT/RT, CR800-D]
[MELSEC iQ-F]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]
[MELSEC-QnA, MELDAS C6*]
[MELSEC-L]
[MELSEC-FX]
[MELIPC]

• [Specify the destination]
• [CH No.]

Select the channel No. of the controller to be monitored.
The setting range is [1] to [4].
Only the channel No. whose controller is any of the following 
models can be selected.
[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
[MELSEC iQ-F]
[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
[MELSEC-L]
[MELIPC]

• [Network]
Configure the network setting of the controller to be monitored.
Select [Host] to monitor the controller of the host station.
Select [Other] to monitor the controller of another station.

• [Net No.]
When [Other] is selected for [Network], set the network No. of the 
controller to be monitored.
The setting range is [0] to [255].

• [Station No.]
When [Other] is selected for [Network], set the PC station No. of 
the controller to be monitored.
The setting range is [0] to [120].

• [CPU Machine]
Set the CPU No. of the controller to be monitored.
The setting range is [0] to [4].

• [Specify the module]
• [First I/O]

Set the start I/O number of a controller to be monitored.
The setting range is [00] to [FF].
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(aa) Settings for [Recipe Data Operation]
Set the detailed settings to import or export recipe data.
For the details of the recipe function, refer to the following.

➟9.3.3 How to use the recipe

• [Operation Type]
Set the operation to be performed when the touch switch is touched.
· [Import]:

Imports data from the recipe file specified with [Import Source] into 
the recipe data specified with [Recipe No.].

· [Export]:
Exports the recipe data specified with [Recipe No.] to the recipe 
file specified with [Export Destination].

• [Recipe No.]
· [Fixed]:

Specifies the target recipe data with a specific recipe number.
Select this item, and then specify the recipe number of the recipe 
data to be imported or exported.
The setting range is [1] to [32767].
If recipe names are set for each recipe data, the target recipe data 
is selectable from among the recipe names as well.
Click the [Edit] button to display the [Recipe] dialog.
Configure the settings of recipe data as necessary.

· [Device]:
Specifies the target recipe data with a device value.
Select this item, and then specify a device.
You can specify an unsigned 16-bit binary word device or word-
specified bit device.

• [Import Source] and [Export Destination]
When selecting [Import] for [Operation Type], set the import source 
file.
When selecting [Export] for [Operation Type], set the export 
destination file.

• [Specification]
Select the method of specifying a recipe file as the import source or 
export destination.
When selecting [Direct] for [Specification], specify the path to the 
recipe file.
When selecting [Device] for [Specification], specify the start device 
of consecutive devices that store the full path of the recipe file.
You can specify an unsigned 16-bit binary word device.

• [Drive Name]
Set this item when selecting [Direct] for [Specification].
Select the drive in which the import source file or export destination 
file is stored.
The following shows selectable items.
[A:Standard SD Card]
[B:USB Drive]
[E:USB Drive]
[F:USB Drive]
[G:USB Drive]
[X:Current Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

• [Folder Name]
Set this item when selecting [Direct] for [Specification].
Specify the path to the import source folder or export destination 
folder.

• [File Name]
Set the file name of the import source file or export destination file.
The file must be in the binary format (*.G2P), Unicode text format 
(*.TXT), or CSV format (*.CSV).

• [Maximum number of characters]
Set this item when selecting [Device] for [Specification].
Specify the maximum number of characters for the full path of the 
recipe file.
The setting range is [8] to [78].
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(ab) Settings for [File Print]
Set the folder to be displayed when the print file list display screen is called up with a special function switch.
For the details of the file print function, refer to the following.

➟GOT2000 Series User's Manual (Utility)

• [Specify the display path]
Specify the folder to be displayed when the print file list display 
screen is called up.

• [Specification]
Select a method of specifying the folder to be displayed.
When selecting [Direct], specify the folder path directly.
When selecting [Device], specify the start device of consecutive 
devices that store the full path of the folder.
The number of the consecutive devices equals half of the set value 
of [Maximum number of characters].

• [Drive Name]
Set this item when selecting [Direct] for [Specification].
The following shows selectable items.
[A:Standard SD Card]
[B:USB Drive]
[E:USB Drive]
[F:USB Drive]
[G:USB Drive]
[N:Network Drive]
[X:Current Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

• [Folder Name]
Set this item when selecting [Direct] for [Specification].
Specify the folder path.

• [Maximum number of characters]
Set this item when selecting [Device] for [Specification].
Specify the maximum number of characters for the folder path.
The setting range is [1] to [75].

• [Restrict access to the upper hierarchy]
Disables the access to a parent folder from the folder that is 
displayed when the print file list display screen is called up.
8. OBJECT FUNCTION
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

2) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

3) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
4) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

5) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)
3)

5)

When [None] is selected for [Shape]

GOT Graphic Ver.1
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

Item Description

Pattern + Shape color

Background color

Example)

Background color:
Pattern:
Shape color:

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)

4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows selectable items.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)
4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.

• Number of characters: 
The line feed is counted as two characters.

• Number of digits: 
The number of digits of the row with the largest number of digits is displayed.

• Number of rows: 
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
8. OBJECT FUNCTION
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.

➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.

• When only [Device] is set
The comment of the same number as the value of [Device] is displayed regardless of the 
lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows selectable items.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
Setting the user ID enables identifying the object by the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

3) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
For the details, refer to the following.

➟8.2.2 ■4 Disabling the simultaneous press for a touch switch
4) [Delay]

Select the delay.
• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)

5)

6)
7)

8)
9) 10)
8 - 162 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

• [Delay Time]: The setting range is [1] to [5].
5) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

6) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
7) [Set the style and text settings for a switch in non-operating state]

Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
8) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows selectable items.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

9) [Layer]
Select the layer to arrange the object on.
The following shows selectable items.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

10) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
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■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows selectable items.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows selectable items.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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8.2.10 [Key Window Display Switch] dialog

The key window display switch displays a specified key window at a specified position, or displays a cursor on a specified 
object.

Step 1 Select [Object] → [Switch] → [Key Window Display Switch] from the menu.
Step 2 Click the position where you arrange the key window display switch.
Step 3 Double-click the arranged key window display switch to display the setting dialog.

➟■1 [Key Input] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Key Input] tab

1) [Switch Action]

2) [Lamp (Timing to change shape/text)]
Select how to switch touch switch images (shapes of on status and off status).

• Switching the touch switch image according to the touch operation
Select [Key Touch State].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[User ID for a key input]
Set the user ID for the object on which the cursor is displayed when you touch the key 
window display switch.
The setting range is [0] to [65535].

[Key Window Position]

Specify the position (top-left coordinate) where the key window is displayed.
The maximum settable value is one dot smaller than the vertical or horizontal size of the 
GOT screen.
• [X]: Specify the coordinate value of the X axis.
• [Y]: Specify the coordinate value of the Y axis.

[Add] button
Adds actions to the switch.
➟8.2.4 ■1 [Action] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)3)
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• Switching the touch switch image according to the status of the corresponding device
Select [Bit-ON/OFF] or [Word Range].

To switch the touch switch image using the lamp on and lamp off status in combination with the key touch on and 
key touch off status, refer to the following.

➟8.2.4 ■2 [Style] tab

3) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

4) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

Item Description

[Key Touch State]
The shape of the key touch on status is displayed while you touch the touch switch.
The shape of the key touch off status is displayed while you do not touch the touch switch.

[Bit-ON/OFF]
When the bit device set in [Device] turns on, the shape of the lamp off status is switched 
to the shape of the lamp on status. After selecting this item, set the device.
➟6.1.2 How to set devices

[Word Range]

When the word device set in [Device] is within the range specified in [ON Range], the 
shape of the lamp off status is switched to the shape of the lamp on status. After selecting 
this item, set the followings.
• [Device]: Set the word device.

➟6.1.2 How to set devices
• [Data Type]: Select the data type of the word device.

The following shows the items to be selected.
[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD16]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

• [ON Range]: After setting the specified word device, click the [Exp] button to set the 
switching range between the shape of the lamp on status and the shape of the lamp off 
status.

➟6.2.2 Setting Trigger Types

RUN

The shape of on status
is displayed while you touch the touch switch.

M100
ON

The shape of off status
is displayed regardless of the device status
while you do not touch the touch switch.

RUN

M100
ON

Example) Bit: When M100 is set

RUN

The shape of on status
is displayed when M100 is on.

M100
ON

The shape of off status
is displayed when M100 is off.

STOP

M100
OFF
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■2 [Style] tab

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

2) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

3) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
4) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

5) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)
3)

5)

When [None] is selected for [Shape]

GOT Graphic Ver.1

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:
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■3 [Text] tab

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)
4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: 
Copies the setting for when the switch is off to the setting for when the switch is on by clicking the [Copy] button.

• [ON→OFF]: 
Copies the setting for when the switch is on to the setting for when the switch is off by clicking the [Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)

4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: 

Select this item to use the specified comment.
After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.

• Number of characters:
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
8 - 172 8. OBJECT FUNCTION
8.2 Placing a Touch Switch



8

O
B

JE
C

T 
FU

N
C

TI
O

N

[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.

➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.

• When only [Device] is set
The comment of the same number as the value of [Device] is displayed regardless of the 
lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Monitors multiple devices by switching between them.

➟6.1.11 Offset

3) [Simultaneous Press]
Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

4) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

Item Description

[Switch]
Set the offset device for the switch function.

➟6.1.2 How to set devices

[Lamp]

Set the offset device for the lamp function.

➟6.1.2 How to set devices
• [Same as the switch offset]

Uses the offset device set for [Switch].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)

6)

7)
8) 9)
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• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

• [Delay Time]: The setting range is [1] to [5].
5) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

6) [Set the style and text settings for a switch in non-operating state]
Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
7) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

8) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

9) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
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■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types
4) [Repeat the operation while the switch is pressed]

Select this item to allow the switch to repeat the same operation while you touch the touch switch.
For operations for which [Repeat the operation while the switch is pressed] can be set, refer to the following.

➟8.2.3 Precautions for a touch switch

Item Description

[Start Delay] Set the time period from when you touch the touch switch to when the operation repeat 
starts. The setting range is [1] to [20].

[Cycle Period] Set the cycle for the operation repeat.
The setting range is [1] to [10].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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8.2.11 [Key Code Switch] dialog

The key code switch enables key input into numerical input and text input, alarm display, data list display, and alarm 
control.

Step 1 Select [Object] → [Switch] → [Key Code Switch] from the menu.
Step 2 Click the position where you arrange the key code switch.
Step 3 Double-click the arranged key code switch to display the setting dialog.

➟■1 [Key Code] tab
■2 [Style] tab
■3 [Text] tab
■4 [Extended] tab
■5 [Trigger] tab

■1 [Key Code] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Key Code Type]
Specify the key code type.

• [Numerical/Text Input]: Inputs a key code for the numerical input or text input.
• [Alarm Display]: Inputs a key code for the alarm display (user), alarm display (system), or simple alarm display.

➟9.1.5 Viewing alarm events (Alarm display)
8.13.2 How to use the system alarm display

• [Recipe Display (Record List)]: Inputs a key code for the recipe display (record list).
➟8.14.1 Specifications of the recipe display (record list)

• [Historical Trend Graph/Historical Data List]: Inputs a key code for the historical trend graph or historical data 
list display.

➟8.21.1 Specifications of the historical trend graph
• [Document Display]: Inputs a key code for the document display.

➟8.26.3 How to use the document display (for Document Converter output files)
• [Screen Gesture]: Inputs a key code for the screen gesture.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

6)5)

1)

3)
4)
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2) [Code Setting]

3) [User ID for a key input]
Set the user ID for the object on which the cursor is displayed when you touch the key code switch.
The setting range is [0] to [65535].

4) [Add] button
Adds actions to the switch.

➟8.2.4 ■1 [Action] tab
5) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

6) [Convert to Lamp] button
Converts the object type to the lamp.

➟8.2.2 How to use touch switch

Item Description

[Numerical/Text]

Inputs a numerical value or a character in its key code.
Select an item for [Character Code], enter a numerical value or character in the selected 
character code, and click the [Convert to Key Code] button. The entered value or character 
is automatically converted to its key code.
The following shows the items to be selected for [Character Code].
• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]
• [Not specify]
When [Not specify] is selected for [Character Code], no character code conversion is 
executed and the key code switch operates using the character code set in the linked text 
input.

[Action]

Sets an action using its key code.
Selecting [Switch window screens for text (screen no. specification)] displays a spin box.
Specify the screen to be displayed.
The setting range is [1] to [10].
8. OBJECT FUNCTION
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function. 
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab. The status 
of when the switch does not function is displayed only when [Set the style and text settings for a switch in non-
operating state] is set in the [Extended] tab.

2) [Collectively set ON/OFF shape in the case of basic figure]
This item is available when [Basic Figure] is selected for [Shape].
Select this item to collectively change the shapes of the touch switches except [Press Twice].

3) [Shape]
Set the shape of the touch switch.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
4) [Reverse switch area]

This item is settable when an image in a state other than [Press Twice] and [When switch does not work] is selected 
in the preview list and [Shape] is set to [None].
Inverts the color of the touch switch.
When [Change a shape based on the key touch state] is selected, the touch switch is reversely displayed by 
switching between the key touch on and key touch off status.

5) [Shape Attribute]

Item Description

[Frame Color] Select the frame color of the touch switch shape.

[Shape Color] Select the lamp color of the touch switch shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)
3)

5)

When [None] is selected for [Shape]

GOT Graphic Ver.1
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■3 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.7.3 5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

[Pattern], [Background Color]

Select the background color and the pattern for the touch switch shape.
The selected pattern in the shape color is displayed on the background color.

Item Description

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) [Text]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

1)

3)
4)

2)

5)

6)
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5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the status when the device turns on or off, the switch is pressed twice, and the switch does not function.
The status of [Press Twice] is displayed only when [Press Twice] is set in [Delay] in the [Extended] tab.
The status of when the switch does not function is displayed only when [Set the style and text settings for a switch 
in non-operating state] is set in the [Extended] tab.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

3)
4)

5)

2)

6)

7)

8)
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5) [Preview]

6) [Comment Group]

7) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]: Select this item to use the specified comment.

After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]: Select this item to display the comment No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.
8. OBJECT FUNCTION
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[Offset]

Set this item to change the text display of the touch switch according to the device value.
➟6.1.2 How to set devices
This setting is available only when [Device] is selected for [Comment No.].
Click the [Setting] button, and set the offset in the [Offset Setting] dialog.

• [Device]
Set this item to change the text display of the touch switch according to the device value.

➟6.1.2 How to set devices
• [Constant]

Set this item to add another value to the value of [Device] according to the indication 
status (on or off) of the lamp. After selecting this item, set the value to be added in the 
lamp on and off status.
• When only [Device] is set

The comment of the same number as the value of [Device] is displayed regardless of 
the lamp status.

• When [Device] and [Constant] are set
When the lamp is on, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](ON) is displayed.
When the lamp is off, the comment of the same number as the value derived from the 
addition of [Device] + [Constant](OFF)] is displayed.

Item Description

Device

Lamp ON

Comment No. 10 is displayed.

Lamp OFF

Line A operation Line A operation

10

[Constant](ON)

Lamp ON

Comment No. 11 is displayed. Comment No. 10 is displayed.

Lamp OFF

Line B operation Line A operation

1

Device 10

[Constant](OFF) 0

Device 10
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Simultaneous Press]

Select this item to disable the simultaneous press for the switch and to set the action having a higher priority.
The following shows the items to be selected.

• [ON Priority]
• [OFF Priority]

For the details, refer to the following.
➟8.2.2 ■4 Disabling the simultaneous press for a touch switch

4) [Delay]
Select the delay.

• [None]: Select this item to set no delay.
• [ON]: Select this item to allow the switch to turn to the on status by pressing the touch switch for the set time.

This setting can prevent incorrect operation.
• [OFF]: Select this item to allow the switch to turn to the off status after the set time passes since the touch switch 

is turned off.
The switch is on during the set time.

• [Press Twice]: Select this item to allow the switch to function after you touch the touch switch once and then 
touch again within the set time.
After selecting this item, configure the settings for [Press Twice] in the [Style] tab and the [Text] tab.
Click the [To Style tab] and [To Text tab] buttons, and set [Press Twice] in the preview list.
After selecting the delay, set the delay time.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)

5)

6)

7)
8) 9)
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• [Delay Time]: The setting range is [1] to [5].
5) [Buzzer]

Select the timing of the buzzer when you touch the touch switch.
• [Always]: The buzzer is sounded every time you touch the touch switch.

In GT21 and GS21, the buzzer does not sound if the security level of the operator is insufficient.
• [Only if conditions are met]: The buzzer is sounded only when you touch the touch switch with the operating 

condition satisfied.
• [None]: The buzzer is not sounded even when you touch the touch switch.

Set the following items when [Always] or [Only if conditions are met] is selected.
• [One Shot]: Select this item to sound the buzzer only at the moment you touch the touch switch.
• [During Push]: Select this item to keep sounding the buzzer while you touch the touch switch.

6) [Set the style and text settings for a switch in non-operating state]
Select this item to set how the touch switch is displayed when the operating condition in the [Trigger] tab is not 
satisfied or when the touch switch does not function due to the unsatisfied security level.
[To Style tab] button: Displays the [Style] tab. Set the shape displayed when the touch switch does not function.

➟8.2.4 ■2 [Style] tab
[To Text tab] button: Displays the [Text] tab. Set the text displayed when the touch switch does not function.

➟8.2.4 ■3 [Text] tab
7) [KANJI Region]

Select a KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

8) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

9) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
8. OBJECT FUNCTION
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■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Setting]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types
4) [Repeat the operation while the switch is pressed]

Select this item to allow the switch to repeat the same operation while you touch the touch switch.
For operations for which [Repeat the operation while the switch is pressed] can be set, refer to the following.

➟8.2.3 Precautions for a touch switch

Item Description

[Start Delay] Set the time period from when you touch the touch switch to when the operation repeat 
starts. The setting range is [1] to [20].

[Cycle Period] Set the cycle for the operation repeat.
The setting range is [1] to [10].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
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8.2.12 Relevant settings

Set the relevant settings other than the specific settings for the touch switch as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings ([Screen Switching/Windows])
Select [Common] → [GOT Environmental Setting] → [Screen Switching/Windows] from the menu to display the 
[Environmental Setting] window.

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

■3 GOT environmental settings (key window), screen property
Set the following functions for each project (GOT environmental settings) or for each screen (screen property).

➟5.2.4 Setting key windows ([Key Window])
• Settings for each project (GOT environmental settings)

Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display the [Environmental 
Setting] window.

• Settings for each screen (screen property)
Select the screen editor on which the key window is to be set and select [Screen] → [Screen Property] from the menu 
to display the [Screen Property] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Setting the timing for the screen switching when you touch the Go To 
Screen switch. (ON synchronous/OFF synchronous)

[Operation Timing]
(Not available to GT21 and GS21)

Function Setting item

Displaying the key window when the operating condition is satisfied.
Set this function in the following item in the [SP Function] tab and [Key 
Window Advanced Setting] tab.
• [Key Window]

Displaying the key window when the screen is switched.
Set this function in the following item in the [SP Function] tab and [Key 
Window Advanced Setting] tab.
• [Display the key window]

Displaying the cursor when the screen is switched.
Set this function in the following item in the [SP Function] tab and [Key 
Window Advanced Setting] tab.
• [Display the cursor]

Displaying the cursor when the operating condition is satisfied.
Set this function in the following item in the [SP Function] tab and [Key 
Window Advanced Setting] tab.
• [Cursor]

Deleting the key window and cursor when the operating condition is not 
satisfied.

Set this function in the following item in the [SP Function] tab and [Key 
Window Advanced Setting] tab.
• [Clear the key window and the cursor] in [When operating conditions are 

not satisfide]
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■4 GOT type settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information...] from the menu to display the [Environmental 
Setting] window.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■5 Sound file settings
Select [Common] → [Sound] → [Sound File Setting] from the menu to display the setting dialog.

➟10.12.8 [Touch Key Sound Setting] dialog

■6 GOT internal device
➟12.1 GOT Internal Device

Function Setting item

Notifying the key codes set to the input keys when the keys are input to text 
input, touch switch, or other objects. (Write device) [Key Code Input]

Disabling the key input. (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

Function Setting item

Using a sound file for the sound generated when you touch the touch 
switch.
(The sound file must be registered.)

[Use a sound file for touch key tone]
(Not available to GT21 and GS21)

Canceling the currently output sound and outputs the sound of the touch 
switch in priority to the canceled sound when you touch the touch switch.

[Give top priority to sound output of a switch]
(Not available to GT21 and GS21)

Function Setting item

Setting the operation timing of the touch switch in which the bit alternate, 
bit set, or bit reset action and the screen switching or station No. switching 
action are set.

GS450.b12
(Not available to GT21 and GS21)

Saving the history of screen transitions to the memory card.
GS450.b13
(Not available to GT21 and GS21)

Switching the operation when the screen is switched to the previous 
screen by using the touch switch.
(Hierarchy/Historical)

GS450.b14
(Not available to GT21 and GS21)
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8.3 Placing a Lamp

■1 Bit lamp
Turns on or off according to the status of the bit device.

➟8.3.4 [Bit Lamp] dialog

■2 Word lamp
Changes the lamp color according to the value of the word device.

➟8.3.5 [Word Lamp] dialog

■3 Lamp area

Switches two colors of the figure and object within the specified area in units of dots according to the status of the bit 
device.

➟8.3.6 [Lamp Area] dialog

■4 Difference between the lamp and the figure to which a lamp attribute is set
When the lamp attribute is set to the figure, the color of the figure can also be changed like the lamp by turning on the bit 
device.

➟7. FIGURES
For the figure with the lamp attribute, only the color can be changed by turning on the bit device.
To set layers or texts to the object, use the lamp.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

X10 = ON X10 = OFF

ON OFF

RUN STOP

D100 = 1 to 99 D100 = 100 or greater

RUNSTOP Error

OFF ON BLINK

D100 = 0

GOT Graphic Ver.1

M100 = OFF M100 = ON
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8.3.1 Specifications of lamps

The following shows the specifications of the lamp.

■1 Maximum number of objects arrangeable on one screen
Up to 1024 objects can be arranged on one screen. Maximum number of lamps is calculated by subtracting the number 
of objects other than lamps including objects with the lamp attribute from 1024.

■2 Minimum size of lamp
The minimum size of the lamp is 2 dots (height) × 2 dots (width).

8.3.2 How to use lamp

The following shows how to use the lamp.

■1 Arranging the lamp
Arrange the lamp on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing the lamp
Edit the lamp arranged on the screen editor.

➟6.5.3 Editing figures and objects

■3 Setting the lamp
Configure the settings for the lamp arranged on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Settings of lamps
➟8.3.4 [Bit Lamp] dialog

8.3.5 [Word Lamp] dialog
8.3.6 [Lamp Area] dialog

8.3.3 Precautions for a lamp

This section explains the precautions for lamps.

■1 Precautions for drawing
(1) Reducing basic figures in size

When the basic figure is set on the lamp, reducing the lamp in size may not display the figure properly.

(2) Reading GT Designer2 format file for GOT-F900 series
When the GT Designer2 format file for GOT-F900 series is read into GT Designer3, the bit lamp area is converted into 
the lamp area.

➟2.3.2 ■3 Opening a project for GOT900
To set the actions of the lamp area to be the same as those of the bit lamp area, the display order of the objects must be 
configured.
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.
Select [Adjust object display order in GOT to the one in GT Designer3].

(3) Converting the lamp to the touch switch
(a) Settings to be deleted

When the lamp is converted to the touch switch, some of the settings are deleted.
The deleted settings are applied as the default setting for the touch switch.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Converting basic figures
For converting the basic figure from the lamp to the touch switch, the figure of the lamp is converted to the corresponding 
figure with the same number on the switch.
Example: Converting the lamp to the touch switch when the basic figure [Square_3D_Fixed Width _Push] is set for the 
lamp

Even if the shapes have the same reference number, there may be difference between the lamp and the touch switch. 
Check the shape after the conversion to see if it can be properly used.

(c) Object size at conversion
If the lamp with the object size incompatible with the touch switch is converted, the converted touch switch is adjusted to 
have the applicable size.

(d) Restoring the touch switch to the lamp after the conversion
To restore the touch switch to the lamp after conversion, select [Edit] → [Undo] from the menu.
Even if the touch switch has been converted back to the lamp, the previous settings cannot be restored.
If the [OK] button is not clicked, clicking the [Cancel] button cancels the conversion even after the [Convert to Switch] 
button is clicked.

(e) Types of the touch switch to be converted to
Both the bit lamp and word lamp are converted to the switch.

Converting
to the corresponding basic figure

Converting
to the shape of the same number

Lamp Touch switch
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8.3.4 [Bit Lamp] dialog

A bit lamp turns on or off according to the status of the bit device.
Step 1 Select [Object] → [Lamp] → [Bit Lamp] from the menu.
Step 2 Click the position where you arrange the bit lamp.
Step 3 Double-click the arranged bit lamp to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Text] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Script] tab

■1 [Device/Style] tab

Set the target device to be monitored and the lamp shape (figure and color) for the on and off status of the device.

1) [Lamp Type]
Select the lamp type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) Preview list

Displays the shapes for the on and off status.
4) [Shape]

Set the lamp shape.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
5) [Shape Attribute]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Frame Color] Select the frame color of the lamp shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

6)

3)

5)

4)

7)
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6) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

7) [Convert to Switch] button
Converts the object type to the touch switch.

➟8.3.2 How to use lamp

■2 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

[Shape Color]
Select the lamp color of the lamp shape.
When the shape in the library (other than the favorite) is selected for [Shape], changing the lamp color sets 
the selected shape in the different color.

[Pattern], [Background Color]

Select the pattern and background color of the lamp shape.
The selected pattern in the shape color is displayed on the background color.

[Blink]

Select the blinking speed of the lamp.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Item Description

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

(1) [Text]

1) Preview list
Displays the shapes for the on and off status.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

1)

3)
4)

2)

5)

6)
8 - 198 8. OBJECT FUNCTION
8.3 Placing a Lamp



8

O
B

JE
C

T 
FU

N
C

TI
O

N

5) [Common Setting of Display Position]

6) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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(2) [Comment]

1) Preview list
Displays the shapes for the on and off status.

2) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

3) [Copy Range]
Set the range to be copied.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

4) [OFF→ON], [ON→OFF]
Copies the text setting.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

5) [Preview]

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

1)

3)
4)

5)

2)

6)

7)

8)
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6) [Comment Group]

7) [Comment]

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Group No.]

Set the comment group No. to be used.
• [Fixed]:

Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

• [Device]:
Select this item to display the comment group No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.

➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]:

Select this item to use the specified comment.
After selecting this item, directly enter the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.

• Number of characters:
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]:
Select this item to display the comment No. corresponding to the value of the device to 
be set.
After selecting this item, set the device.

Item Description
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8) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the security level, offset, layer, category, and KANJI region.

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [KANJI Region]

Select the KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)
3)

2)

5)
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4) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

5) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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➟6.2.1 ■2 Correspondence between functions and trigger types
3) [Settings]

For details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

■5 [Script] tab

For the settings of scripts, refer to the following.
➟9.8 Controlling Operations with Scripts ([Script])

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.3.5 [Word Lamp] dialog

A word lamp changes its color according to the value of the target word device.
Step 1 Select [Object] → [Lamp] → [Word Lamp] from the menu.
Step 2 Click the position where you arrange the word lamp.
Step 3 Double-click the arranged word lamp to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Text] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Device/Style] tab

Set the target device to be monitored and the lamp shape (figure and color) corresponding to the device value.

1) [Lamp Type]
Select the lamp type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) [Data type]

Select the data type of the word device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

6)
5)

2)
1)

3)

11)

12)

13)

14)

16)

4)

10)

15)

7) 8) 9)
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• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

4) Preview list
Displays set conditions.

5) [Text] button
Displays the preview list in text.

6) [Range] button
Displays the preview list in range.

7) Add button
Adds a new condition.

8) Delete button
Deletes a selected condition.

9) Up button, down button
Changes the order of priority of the selected condition.

10) [Utilize] button
Creates a new condition utilizing the selected condition.

11) [Range]
Set a condition which changes the display property of the lamp. When setting the value of the word device as the 
condition, click the [Exp] button to display the [Edit Range] dialog, and then set the conditional expression.
For the details of conditions, refer to the following.

➟6.5.5 ■2 Setting conditions
12) [Shape]

Set the lamp shape.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
13) [Shape Attribute]

14) [To Text Tab] button
Displays the [Text] tab.

15) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.

Item Description

[Frame Color] Select the frame color of the lamp shape.

[Shape Color]
Select the lamp color of the lamp shape.
When the shape in the library (other than the favorite) is selected for [Shape], changing the lamp color sets 
the selected shape in the different color.

[Pattern], [Background Color]

Select the pattern and background color of the lamp shape.
The selected pattern in the shape color is displayed on the background color.

[Blink]

Select the blinking speed of the lamp.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select an area to be blinked.
The following shows the items to be selected.
• [Shape and Text]
• [Shape only]

Pattern + Shape color

Background color

Example)

Background color:
Pattern:
Shape color:
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The name is changeable on the other tabs as well.
Up to 100 characters can be set.

16) [Convert to Switch] button
Converts the object type to the touch switch.

➟8.3.2 How to use lamp

■2 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Select the text type to use the directly input texts or the comments set in a comment group as a text.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) Preview list
Displays set conditions.

2) [Range] button
Displays the preview list in range.

3) [Text] button
Displays the preview list in text.

4) Add button
Adds a new condition.

5) Delete button
Deletes the selected condition.

6) Up button, down button
Changes the order of priority of the selected condition.

7) [Utilize] button
Creates a new condition utilizing the selected condition.

1)

7)

8)

9)

10)

2)
3)

4) 5) 6)
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8) [Common Setting of Display Position]

9) [Text Settings]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button

Up

Down

CenterLeft Right
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10) [To Style Tab ] button
Moves to the [Device/Style] tab.

(2) [Comment]

1) Preview list
Displays set conditions.

2) [Range] button
Displays the preview list in range.

3) [Text] button
Displays the preview list in text.

4) Add button
Adds a new condition.

5) Delete button
Deletes the selected condition.

6) Up button, down button
Changes the order of priority of the selected condition.

7) [Utilize] button
Creates a new condition utilizing the selected condition.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

Text

Offset to Frame

1)

7)

8)

9)

10)

11)

12)

2)
3)

4) 5) 6)
8. OBJECT FUNCTION
8.3 Placing a Lamp

8 - 211



8) [Preview]

9) [Comment Group]

10) [Comment]

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Group No.]

Set the comment group No. to be used.
• [Fixed]:

Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

• [Device]:
Select this item to display the comment group No. corresponding to the value of the 
device to be set.
After selecting this item, set the device.

➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]:

Select this item to use the specified comment.
After selecting this item, set the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
· Number of characters:

The line feed is counted as two characters.
· Number of digits:

The number of digits of the row with the largest number of digits is displayed.
· Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

· [Device]:
Select this item to display the comment No. corresponding to the value of the device to 
be set.
After selecting this item, set the device.

[To Style Tab ] button Moves to the [Device/Style] tab.
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11) [Text Settings]

12) [To Style Tab ] button
Moves to the [Device/Style] tab.

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

[Change comment attributes]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Text

Offset to Frame

[Solid] button
[Raised] button

[Bold] button
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
The value of [Input] must be greater than that of [Display].

2) [Use offset]
Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [KANJI Region]

The following shows the items to be selected.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

This setting is available only when any of the following fonts is selected in the [Text Settings] tab.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

4) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4) 5)
8 - 214 8. OBJECT FUNCTION
8.3 Placing a Lamp



8

O
B

JE
C

T 
FU

N
C

TI
O

N

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

5) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
3) [Settings]

For details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]

The setting items differ depending on which function to select.
The next page shows the setting items for each function.

Item Description

[None] Select this item if the data operation function and script function is unnecessary.

[Data Operation] Set the expression used for the data operation function.

[Script]
Not available to GT21 and GS21.
Set the expression used for the script function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[None] Select this item not to perform the data operation by using the expression.

[Edit Data Expression] Select this item to perform the data operation by using the expression.

[Exp] button

This button appears only when [Data Expression] is selected for [Data Operation].
Click the [Exp] button to set the format of the expression in the [Edit Data Expression] 
dialog.
➟6.5.5 ■4 (3) [Edit Data Expression] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) Script

For the settings of the data operation function, refer to the following.
➟9.8 Controlling Operations with Scripts ([Script])

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.3.6 [Lamp Area] dialog

In a specified lamp area, two colors of the figure and object are switched in units of dots according to the status of the bit 
device.

Step 1 Select [Object] → [Lamp] → [Lamp Area] from the menu.
Step 2 Click the position where you arrange the lamp area.
Step 3 Adjust the dotted frame to specify the applicable lamp area.
Step 4 Double-click the arranged lamp area to display the setting dialog.

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Trigger]

Select the on or off status of the bit device as the condition for the colors to be switched.
The following shows the items to be selected.

• [ON]
• [OFF]

3) [Color Setting]
Set [Color 1] and [Color 2] as the two target colors to be switched when the condition is satisfied.
The set colors are switched every time the condition is satisfied.

4) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15]. Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
5) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]

Select the same layer as that of the figure and object to which the lamp area is applied.
➟6.5.5 ■3 Superimposition

6) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
7) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.1

3)

1)
2)

4)
6)5)

7)
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(1) Applying the lamp area
When using the lamp area, set the following items for the lamp area, and the figure and object to which the 
lamp area is applied.
(a) Applicable area

The colors are switched within the lamp area regardless of the shape of the figure and object.
When a part of the figure or object is outside the lamp area, the area is not applied to the part.
Specify the applicable lamp area so that the figure and object are within the dotted frame of the lamp 
area.

(b) Layer
Not available to GT21 and GS21.
Arrange the lamp area, and the figure and object to which the lamp area is applied on the same layer.

(c) Arrangement order
Arrange the figure and object to which the lamp area is applied behind the lamp area.
(If the figure and object are arranged before the lamp area, they are arranged behind the lamp area.)
To change the arrangement order, right-click on the selected figure or object and select [Stacking 
Order].

(d) Display order
Set the display order of the objects in the applied lamp area.
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.
Select [Adjust object display order in GOT to the one in GT Designer3].

(2) Setting the same color for the switching color of the lamp area as the transparent color of 
the front layer
Not available to GT21 and GS21.
On the front layer to which the lamp area is applied, when either [Color 1] or [Color 2] in [Color Setting] is 
set to the same color as [Front Layer Transparent], the transparent color (The back layer is displayed.) and 
the other color are switched.
The colors are switched not only for the figure or object, but also for the whole lamp area.
For the details of [Front Layer Transparent], refer to the following.

➟2.5.1 ■1 Creating a base screen

(3) Checking action of the lamp area in the preview window and screen editor
The preview window and screen editor cannot check that the colors are switched for the lamp area.

Example) When         and            are set for [Color Setting] of the lamp area

Example) When          and            are set for [Color Setting] of the lamp area and            is set for [Front Layer Transparent]

The color of the entire transparent part
in the lamp area is changed to              .
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8.3.7 Relevant settings

Set the relevant settings other than the specific settings for the lamp as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.4 Placing a Numerical Display and Numerical Input

■1 Numerical display
With this function, the data stored in devices are displayed numerically on the GOT.

■2 Numerical Input
With this function, values entered into the GOT are written into devices.

(1) Entering values with keys for entries
As keys for entries, a key window and touch switches to which key codes are assigned are available.

(a) Entering with touch switches placed on the screen

(b) Entering from a key window
➟5.2.4 Setting key windows ([Key Window])

(2) Inputting values with a barcode reader or RFID
➟10.1 Using a Barcode Reader with the GOT (Barcode Function)

10.2 Using an RFID with the GOT (RFID Function)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100 = 722D100 = 349

D100 349 D100 722

C AC51 2 3 4
-06 7 8 9

123

C AC51 2 3 4
-06 7 8 9

1234

123 1234

123456789

Barcode

The corresponding numerical value is
input in a touched numerical input.

Barcode reader

C AC51 2 3 4
-06 7 8 9

123456789
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8.4.1 Specifications of the numerical display and numerical input

■1 Maximum number of objects arrangeable on one screen
The maximum number of objects on one screen depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 1024 numerical displays and numerical inputs can be placed on one screen.

• For GT21 and GS21
Up to 1024 numerical displays can be placed on one screen.
Up to 100 numerical inputs can be placed on one screen.

■2 Display when a data operation error occurs
If there is any of the following errors in an operation of the displayed data, the object displays the number of hyphens 
corresponding to the number of displayed digits.

• BCD-BIN conversion error
• Division by zero error
• 64-bit operation overflow

While the object displays hyphens, touch the input value area to display 0 in the area.

(1) Display of a value containing a symbol or decimal point
A symbol and a decimal point, which are contained in a value, are also displayed as hyphens.
Example) When the settings are configured as follows: display format: real, number of displayed digits: 8 (fractional 
portion: 5), and right alignment

(2) Display when characters and numerics are displayed together
Of a character string specified as [Format String], numerics are displayed as hyphens, and characters are displayed as 
they are.
Example) When the settings are configured as follows: display format: decimal, specified character string: ##m##cm, and 
right alignment

■3 Displaying with level objects superimposed
A numerical display or numerical input can be superimposed on a level object.
For restrictions imposed on displaying with level objects superimposed, refer to the following.

➟8.23 Placing a Level Object

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display at an error occurrenceNormal display

-1.23456 --------

Display at an error occurrenceNormal display

1 m 2 0 cm -- m -- cm
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8.4.2 How to use the numerical display and numerical input

■1 Placing the numerical display and numerical input
Place numerical displays and numerical inputs on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing numerical displays and numerical inputs
Edit numerical displays and numerical inputs that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting numerical displays and numerical inputs
Set numerical displays and numerical inputs that have been placed on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Numerical display settings
➟8.4.4 [Numerical Display] dialog

• Numerical input settings
➟8.4.5 [Numerical Input] dialog

■4 Using numerical inputs on base screens and window screens
If numerical inputs are displayed on both a base screen and an overlap window simultaneously, the cursor for entries is 
displayed on the overlap window by the operations other than a touch operation (such as the display of the key window 
with the special function switch).
To display the cursor for the numerical input on the base screen, touch the numerical input on the base screen.

■5 Inputting a value with a key code switch on a base screen
When key code switches are placed on a base screen and are used, values can be entered without the display of a key 
window.
For key code switches, refer to the following.

➟8.2.11 [Key Code Switch] dialog

■6 Inputting a value with a barcode reader or RFID
Numerical values can be input using a barcode reader or RFID.
When inputting numerical values from a barcode reader or RFID, set the barcode function or RFID function.

➟10.1 Using a Barcode Reader with the GOT (Barcode Function)
10.2 Using an RFID with the GOT (RFID Function)

■7 Specifying the destination to which the cursor moves after the confirmation of a numerical 
value entry

When [User ID] is set, the destination to which the cursor moves after the confirmation of a numerical value entry can be 
specified.
[User ID] can be set only when numerical inputs are used.

➟8.4.5 ■4 [Extended] tab

(1) About [User ID]
When [User ID] is set, the following setting and operations are enabled.

• Setting the position where the cursor is displayed at screen switching
➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

• Storing in a device the timing with which an entered numerical value is confirmed
➟(a) The timing with which numerical value entries are confirmed (system information)

• Moving the cursor in ascending or descending order of user ID number
➟(b) Moving the cursor in ascending or descending order of user ID number

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) The timing with which numerical value entries are confirmed (system information)
When a numerical value entry is confirmed with the numerical input function, the corresponding user ID number is written 
in [Numeric Value Input Number] of [System Information], and the Numeric Value Input signal (System signal 2-1.b4) 
turns on.
When deleting the user ID written in the numeric value input number (System signal 2-1.b4) and turning off the Numeric 
Value Input signal (System signal 2-1.b4), turn on the Numeric Value Input Read Complete signal.
(After clearing, turn off the Numeric Value Input Read Complete signal (System signal 1-1.b4).) Otherwise user ID 
numbers cannot be stored and bit devices cannot turn on even when numerical value entries are confirmed.

(b) Moving the cursor in ascending or descending order of user ID number
When the following key code switches are used, the cursor can be moved in ascending or descending order of user ID 
number.

• User ID ascending order movement of cursor (key code: 0092h)

The cursor is moved in order of 1) → 2) → 3).
After 3), the cursor does not move because the destination user ID number does not exist.

• User ID descending order movement of cursor (key code: 0093h)

The cursor is moved in order of 1) → 2) → 3).
After 3), the cursor does not move because the destination user ID number does not exist.

ON

OFF

OFF
ON

1 2Key input of a numerical input

Numeric Value Input signal

Numeric Value Input signal

System signal 2-1.b4

Numeric Value Input Read 
Complete signal
System signal 1-1.b4

Enter

Stores the user ID number Stores 0

0

00

01

User ID: 1 User ID: 2

User ID: 2

0

User ID: 3

The user ID is duplicated. The cursor is not moved. 
If the user ID is duplicated, the cursor is moved to 
the object whose object ID is the minimum.

User ID: 4

1)

3)2)

0

00

01User ID: 1 User ID: 2

User ID: 2

0

User ID: 3

The user ID is duplicated. The cursor is not moved. 
If the user ID is duplicated, the cursor is moved to 
the object whose object ID is the minimum.

User ID: 4

3)

1)2)
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(2) User ID setting
When controlling the cursor using user ID numbers, assign different user ID numbers to each object.
Also, when using overlay screens or superimpose windows, set screens in a way that different user ID numbers are 
assigned to each object.
When the same user ID number is assigned to different objects, the cursor operation may not perform normally.

• When assigning different user ID numbers to each object
Even when overlay screens or superimpose windows are used, the cursor operation using user ID numbers is 
performed normally.

• When assigning the same user ID number
If objects which have the same user ID exist on the screen (including set overlay screens and superimpose windows), 
the cursor operation using user ID numbers may not perform normally.

(3) The relation between user ID and destination ID
The destination ID number is the user ID number of the numerical input where the cursor is moved next.

➟8.4.5 ■4 [Extended] tab
Example) Moving the cursor using the destination ID number

Base screen 1

Window screen 1

1) to 4): User ID
C

D

A

B

0

0 0

1)2)

3) 4)

128

Base screen 1

Window screen 1

1) to 2): User ID
C

D

A

B

0

0 0

1)1)

2) 2)

128

A

C

B

D

1)

2)

3)
4)

0

00

01

User ID: 1 User ID: 2

User ID: 4User ID: 3

Numerical Input User ID Destination ID

A 1 2

B 2 3

C 3 4

D 4 1
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8.4.3 Precautions for a numerical display object and a numerical input object

■1 Precautions for use
(1) Space or symbol entry

If you enter only a space or symbol and then touch the [Enter] key, the entry is cancelled.
To enter only a space or symbol as a device value, use the text input.

➟8.5.2 How to use the text display and text input

(2) Operations when a key window is called up with a special function switch (Key windows)
The following shows the operations when a key window is called up with a special function switch in which [Key Windows] 
is set for the switch action, while no cursor appears on the numerical input.

• When using the standard key window
The standard key window for decimal numbers is displayed.

• When using a key window a user created
Screens set for [Window Screen No.] for decimal numbers are displayed.
When [Window Screen No.] for decimal values is not set (or set to 0), the standard key window for decimal numbers 
is displayed.

(3) Entering an integer when using GT27, GT25, or GS25
When you enter an integer in a device that satisfies all the following conditions, the value to be stored in the device and 
the value to be displayed on the GOT differ.

• [Data Type] in the [Device] tab is set to [Real(32bit)].
• [Format] in the [Device] tab is set to [Binary] or [Hexadecimal].

Example) Entering 1 (integer) in the device for which [Data Type] is set to [Real(32bit)] and [Format] is set to 
[Hexadecimal]

• Value to be stored in the device: 1 (integer)
• Value to be displayed on the GOT: 0

(4) [Input Case] in the [Numerical Input] dialog
The setting for [Range] in the [Input Case] tab in the [Numerical Input] dialog is effective only when data entry is performed 
with an numerical input object.
If data entry is performed with a different object, through communications, or by any other methods, the setting for 
[Range] is invalid.

➟8.4.5 ■3 [Input case] tab

(5) Input range when GT21 is used
When [Real(32bit)] is selected for [Data Type], if you enter the maximum value of the input range set in the [Input Case] 
tab, the value may be regarded as out-of-range data.
In this case, take one of the following corrective actions.

• Change the selection for [Data Type].
• Extend the input range in the [Input Case] tab.

■2 When setting [ON and OFF] for [Write Check Device]
The setting of [Write Check Device] (write completion device) is available for a text input object as well.
If you specify a common write completion device for a numerical input object and a text input object, or for multiple 
numerical input objects, note the following points.

(1) Number of write completion devices that turn on simultaneously
Do not turn on 21 or more write completion devices simultaneously.
Otherwise the write completion devices that turn on 21st and later do not turn off automatically.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) When specifying a common write completion device for multiple numerical input objects
Set trigger conditions in a way that prevents numerical values from being entered while the same write completion device 
is on.
Example) Setting [Write Check Device] to M10 and [Trigger Type] to [OFF]

If you enter data into a target input object while the common write completion device is on for another target input object, 
the common write completion device does not turn off at the appropriate time.
Example) When entering data into numerical input A while the common write completion device is on for numerical input B

(3) Operations performed at screen switching
Even when screen switching (including switching to utilities) occurs while a write completion device is on, the write 
completion device does not turn off.
The device remains on until a set time elapses.

■3 Checking the input range while entering numerical values
This following describes the precautions taken when designing and operating screens.

(1) When designing screens
(a) Number of conditions that can be set

Set only one condition.
If two or more conditions are set, the input range is checked when the entry is confirmed.

(b) Range expressions set for conditions
Set either of the following patterns.
If setting with a pattern other than following patterns, the input range is checked when the entry is confirmed.

• $W<A, $W<=A
$W: Device set with a numerical input
A: Constant, another device (positive value (+) only)

• A<$W<B, A<=$W<B, A<$W<=B, A<=$W<=B
$W: Device set with a numerical input
A: Constant, another device
B: Constant, another device (positive value (+) only)

(c) When the input range and display range are set individually
Only the input range is checked.

(d) Device whose [Data Type] is [Real(32bit)] or [Real(64bit)]
For a device whose [Data Type] is [Real], the GOT and a controller handle the device value a little differently.
If you set a precise input condition using [==] or [!=], the input range may not be checked properly.
When checking the input range with such a device, do not use [==] and [!=] to set the input condition.
For the data type specifications, refer to the following.

➟1.2.7 ■2 Data type of devices

Numerical input A

Numerical input B

Write completion 
device: (M10)

Off timing corresponding to the entry in numerical input B
Actual off timingON

OFF

3 seconds

0 100

0 400
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(2) In operation
(a) Inputting minus (-)

Input minus (-) then enter a numerical value.

(b) Lower limit check
The lower limit is checked when the entry is confirmed.

(c) Comparing with devices
In a case where comparison with a device is made, a message is displayed when the device value cannot be read.

(d) Moving the cursor
When the cursor in the object is moved while a numerical value is entered, the range is not checked while the numerical 
value is entered.
The input range is checked when the entry is confirmed.
To have the range checked while entering a numerical value, hide the cursor (cancel the input status of the numerical 
input), and then execute the numerical input again.

■4 Number of significant digits in the fractional portion
When the data type is 64-bit and either of the following conditions is satisfied, 14 digits in the fractional portion are 
significant after automatic adjustment.

• Data operation is set.
• Object internal variables are used.

➟9.10.2 ■3 (2) Object internal variables
In the range expression set for the range operation function, 14 digits in the fractional portion are significant, and 
operation is performed with the value before automatic adjustment.

■5 Displaying the input confirmation massage
(1) Number of the digits of a numerical value which can be displayed on the massage

When the number of displayed digits exceeds 35, the values are not displayed on the massage.
Do not input over 35 digits.

(2) Display position of the massage
The display position of the massage depends on the type of the key window.

• When using the standard key window
The message is displayed on the key window.

• When using a user-created key window or using no key window
The message is displayed in the center of the screen.

■6 Blink
The blink of the text display is paused when the input cursor is displayed.

■7 When using a barcode reader or RFID
(1) Reading data from a barcode reader or RFID while entering a numerical value in a key window

Depending on the operation, the read data may or may not be input numerically.
• While displaying dialog windows

The data read from a barcode reader or RFID cannot be input numerically.
• While not displaying dialog windows

The value being input in the key window is abandoned and the data read from a barcode reader or RFID is 
numerically input.

(2) Performing key touch operations while the data read from a barcode reader or RFID is in the process 
of being input
While the data read from a barcode reader or RFID is in the process of being input, key touch operations are invalid and 
the data read from a barcode reader or RFID is input.

(3) When data is not numerical values or insufficient for the specified start position
When the data read from a barcode reader or RFID is applicable to the following cases, the numerical value input is not 
executed for the data.

• Other than numerical values
• The format of the data is different from the setting of [Format]
• The data is insufficient for the setting of [Start Position]
8. OBJECT FUNCTION
8.4 Placing a Numerical Display and Numerical Input

8 - 229



8.4.4 [Numerical Display] dialog

Step 1 Select [Object] → [Numerical Display/Input] → [Numerical Display] from the menu.
Step 2 Click the position where you place the numerical display. Placing the numerical display is complete.
Step 3 Double-click the numerical display which has been placed to display the setting dialog.

➟■1 [Device] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Device] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Numerical Display]
• [Numerical Input]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) [Data type]

Select the data type of the device to be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)2)

4)

6)

8)

5)
7)

9)

11)

12)

13)
15)

When [Fixed] is selected for [Digits (Fractional)]

When [Device] is selected for [Digits (Fractional)]

10)

14)

16)
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The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

4) [Font]
Select the font of the numerical value to be displayed.
The following shows the items to be selected.

• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Gothic]
• [16dot HQ Gothic]
• [TrueType Numerical Gothic]
• [TrueType Numerical 7seg]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

5) [Number Size]
Set the size of the numerical value to be displayed.

➟1.2.5 Font specifications
6) [Alignment]

Set the horizontal position of the numerical value.
7) [Format]

Select the display type of the device to be monitored.
The selectable items vary with the data type of the device.
○ : Available, ×: Not available

[Data Type]
[Format]

[Signed Decimal] [Unsigned 
Decimal] [Hexadecimal] [Octal] [Binary] [Real]

[Signed BIN16] ○ ○ ○ ○ ○ ○

[Unsigned BIN16] ○ ○ ○ ○ ○ ○

[Signed BIN32] ○ ○ ○ × ○ ○

[Unsigned BIN32] ○ ○ ○ × ○ ○

[Signed BIN64] ○ ○ ○ × × ○

[Unsigned BIN64] ○ ○ ○ × × ○

[Signed BIN8] ○ ○ ○ ○ ○ ○

[Unsigned BIN8] ○ ○ ○ ○ ○ ○

[BCD16] ○ ○ ○ ○ ○ ○

[BCD32] ○ ○ ○ × ○ ○

[BCD64] ○ ○ ○ × × ○

[Real(32bit)] ○ ○ ○ × ○ ○

[Real(64bit)] ○ ○ ○ × × ○
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8) [Rounding]
If there is a numerical value that have digits to the right of the digit set for [Digits (Fractional)], select the processing 
method.
The following shows the items to be selected.

• [Round off]
• [Round down]
• [Round up]

9) [Digits (Integral)]
This item is displayed when [Fixed] is selected for [Digits (Fractional)].
Set the number of digits of the integer part to be displayed.
The setting range depends on the setting of [Display Type].

• [Signed Decimal] or [Unsigned Decimal]: [1] to [21]
• [Hexadecimal]: [1] to [16]
• [Octal]: [1] to [6]
• [Binary] or [Real]: [1] to [32]

10) [Display Digits]
This item is displayed when [Real] is selected for [Format] and [Device] is selected for [Digits (Fractional)].
Set the total number of digits of the integer part and fractional part to be displayed.
The setting range is [1] to [32].

11) [Digits (Fractional)]
This item is displayed when [Real] is selected for [Format].
Select a method to specify the number of decimal places, and specify the number of decimal places to be displayed.
The following shows selectable items.

• [Fixed]:
Enter the number of decimal places.
The setting range is [0] to [30].

• [Device]:
Set a device to specify the number of decimal places.
The number of decimal places changes based on the device value.
The data type of the device is unsigned 16-bit binary.

Item Description

[Fill with 0]

When the right justification is set for [Alignment], 0 is prefixed to the numerical value.
Example): When setting [5] for [Digits (Integral)]

When [Format] is set to [Binary], the GOT displays the numerical value prefixed with 0, regardless of the 
setting of [Fill with 0].

[Show "+"]
When the numerical value is positive number, [+] is prefixed to the numerical value.
This item can be set only when [Format] is either [Signed Decimal] or [Real].

[Include signs in the integer 
portion]

A sign is included as one digit in the number of digits of the integer part.
This item can be set only when [Format] is either [Signed Decimal] or [Real].

Item Description

[Fill with 0]

When the right justification is set for [Alignment], 0 is prefixed to the numerical value.
Example) When setting [5] for [Display Digits]

[Show "+"] When the numerical value is positive number, [+] is prefixed to the numerical value.

[Include signs in the display 
digits] Includes a sign as one digit in the number of digits displayed.

5 00005

If prefixed with 0If not prefixed with 0

5 00005

If prefixed with 0If not prefixed with 0
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Set the device value as follows.
X > Y + 1
X: Value set for [Display Digits]
Y: Device value to specify the number of decimal places
If the device value is outside the valid range, 0 is assumed.

12) [Display Range]
Displays the maximum/minimum value which can be displayed on the screen.

13) [Display the numerical value to be shown on the screen with asterisk]
Displays the numerical value, sign, and decimal point to be displayed on the screen in asterisk.
This item can be set when [Font] is set to one other than [TrueType Numerical Gothic] and [TrueType Numerical 
7seg].
The character string (except #) set for [Format String] is not displayed in asterisk.
When saved as an operation log, the text is saved not as an asterisk but as a numerical value.

14) [Format String]
Displays characters (such as alphanumeric characters, kanji, or symbols) in the numerical display
This item can be set when [Font] is set to one other than [TrueType Numerical Gothic] and [TrueType Numerical 
7seg].
Enter #s to the positions where the digits of a numerical value are to be displayed.
The #s entered in setting this item are replaced with the digits of the device value.
Each # is replaced with the digit of the value in the same position counted from the right. If the number of the digits 
of the device value is larger than that of #s, the digits overflowing from the left are not displayed.
The digits of a real number to the right of the decimal point are processed according to the setting for [Rounding].
The sign included in the device value is also processed in the same way that processes the numerical value.
The following shows examples of displays.
Example 1) When the setting for [Format] is not [Real]

Example 2) When setting [Real] for [Format] and [Round off] for [Rounding]

Item Description

[Adjust Decimal Point Range]

(When a value other than binary floating values is held in the monitor target device) the integer device 
value is displayed as a value with the decimal point.
This item can be set when [Format] is [Real] and [Data Type] is set to one other than [Real].

This setting is applied to the monitored device value and the following device values.
• Device values specified for [$V] and [Other Device] that are used in the expression for the display range 

in the [Style] tab
• Device values specified to [$$] and [Other Device] that are used in the expression for a data operation 

in the [Operation/Script] tab

[Format String] [Digits (Fractional)] Device value Display

##m##cm -

1234 12m34cm

123 1m23cm

12345 23m45cm

-123 -1m23cm

[Format String] [Digits (Fractional)] Device value Display Description

##m##cm

0

12.345

m12cm Since [Digits (Fractional)] is 0, only the 
integer part is displayed.

2 12m35cm

Since [Digits (Fractional)] is 2, the digits 
from the integer part to the second 
decimal place are displayed.
The device value is rounded off to the 
third decimal place.

Example) Number of the digits to the right 
                of the decimal point: 2
                Controller device value: 20

Example) Number of the digits to the right 
                of the decimal point: 3
                Controller device value: 20

The value is displayed 
as 0.20 in the GOT.

The value is displayed 
as 0.020 in the GOT.

0.20 0.020
8. OBJECT FUNCTION
8.4 Placing a Numerical Display and Numerical Input

8 - 233



15) [Preview]
Displays the preview of the screen.

16) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(1) Items whose settings are invalid when the format text is used
• The settings of [Digits (Integral)] and [Display Digits] in the [Device] tab become invalid.
• The setting of [Alignment] in the [Device] tab becomes invalid and the right justification is performed.

(2) Characters which cannot be displayed in the format text
When [6x8dot] is set for [Font], and a character other than the ASCII cords (0x20 to 0x7E) is included in the 
format text, the character and all the following characters are not displayed.
In such a case, the cursor may not appear in its default position.

➟12.6 ASCII Code List

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

For the conditions, refer to the following.
➟6.5.5 ■2 Setting conditions

####cm 2
12.344 1234cm

Since [Digits (Fractional)] is 2, the 
device value is rounded off to the third 
decimal place.

12.345 1235cm

##.##cm 2
12.344 12.34cm

12.345 12.35cm

Item Description

[Preview Value] Set the numerical value to be displayed in the preview.

[Format String] [Digits (Fractional)] Device value Display Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3)

4)

6)

5)

7)

8)

9)
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1) Add button
Adds a new condition.

2) Delete button
Deletes the selected condition.

3) Up button, down button
Changes the order of priority of the selected condition.

4) Preview list
Displays set conditions.

5) [Utilize] button
Creates a new condition utilizing the selected condition.

6) [Range]
Set a device of the condition under which a display is changed.

➟6.5.5 ■2 Setting conditions
• [Bit]

Set the value of the bit device.
• [Range]

Set the word device value using a conditional expression.
7) [Common Setting]

These settings are applied to all the conditions to be set.

8) [Shape Attribute]

9) [Text Attribute]

Item Description

[Shape]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

Item Description

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

[Reverse] Inverts the color of the numerical value.

[Blink]

Select the blinking speed of the numerical value and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Data only]
• [Data and Shape]
These settings are applied to all the conditions to be set.

Item Description

[Numerical Color]
Set the color of the numerical value.
➟6.4 Color Settings

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

123456 123456
8. OBJECT FUNCTION
8.4 Placing a Numerical Display and Numerical Input

8 - 235



■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Display Mode]

Display mode when the numerical display is superimposed on a level object.
• [Transparent]: Displays the numerical value on the level object.

• [XOR]: The numerical value in a numerical display is integrated into the XOR synthesis with a level color, to be 
able to be distinguished from the level object.

As the setting is fixed to [Transparent], no additional setting is required accordingly.

The following shows the items to be selected.
• [Transparent]
• [XOR]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)
6)5)

98

20 5050

GOT Graphic Ver.2

GOT Graphic Ver.1
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4) [KANJI region]
Select the KANJI region of the displayed text.
This item can be set only when [Format String] is set in the [Device] tab.

➟1.2.5 Font specifications
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

5) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

6) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Depending on the selection for [Operation Type], the setting items are different.

(1) [Data Operation]

This item can be set only when [Operation Type] is [Data Operation].
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Select the format of the expression operating with the data operation.
The following shows the items to be selected.

• [None]
• [Data Expression]

(2) [Script]

This item can be set only when [Operation Type] is [Script].
For the settings of scripts, refer to the following.

➟9.10 Object Script

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]
• [Right]

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
*3 Not available when [Device] is selected for [Digits (Fractional)].

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device]

[Number Size] (width) text_width ○ ○ When the object is updated

[Number Size] (length) text_height ○ ○ When the object is updated

[Alignment] arrange ○ ○ When the object is updated

[Digits (Fractional)] decimal_point ○*3 ○*3 Upon the setting change

[Style]

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Numerical Color] text_color ○ ○ When the object is updated

[Extended]
[Security Level] security ○ ○ When the object is updated When the screen is updated

[Display Mode] draw_mode ○ ○ When the object is updated
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8.4.5 [Numerical Input] dialog

Step 1 Select [Object] → [Numerical Display/Input] → [Numerical Input] from the menu.
Step 2 Click the position where you place the numerical input. Placing the numerical input is complete.
Step 3 Double-click the numerical input which has been placed to display the setting dialog.

➟■1 [Device] tab
■2 [Style] tab
■3 [Input case] tab
■4 [Extended] tab
■5 [Trigger] tab
■6 [Operation/Script] tab

■1 [Device] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Numerical Display]
• [Numerical Input]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)2)

4)

6)

8)

5)
7)

9)

11)

12)

13)
15)

When [Fixed] is selected for [Digits (Fractional)]

When [Device] is selected for [Digits (Fractional)]

10)

14)

16)
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3) [Data Type]
Select the data type of the device to be set.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

4) [Font]
Select the font of the numerical value to be displayed.
The following shows the items to be selected.

• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Gothic]
• [16dot HQ Gothic]
• [TrueType Numerical Gothic]
• [TrueType Numerical 7seg]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

5) [Number Size]
Set the size of the numerical value to be displayed.

➟1.2.5 Font specifications
6) [Alignment]

Set the horizontal position of the numerical value.
7) [Format]

Select the display type of the device to be monitored.
The selectable items vary with the data type of the device.
○ : Available, ×: Not available

[Data Type]
[Format]

[Signed Decimal] [Unsigned 
Decimal] [Hexadecimal] [Octal] [Binary] [Real]

[Signed BIN16] ○ ○ ○ ○ ○ ○

[Unsigned BIN16] ○ ○ ○ ○ ○ ○

[Signed BIN32] ○ ○ ○ × ○ ○

[Unsigned BIN32] ○ ○ ○ × ○ ○

[Signed BIN64] ○ ○ ○ × × ○

[Unsigned BIN64] ○ ○ ○ × × ○

[Signed BIN8] ○ ○ ○ ○ ○ ○

[Unsigned BIN8] ○ ○ ○ ○ ○ ○

[BCD16] ○ ○ ○ ○ ○ ○

[BCD32] ○ ○ ○ × ○ ○

[BCD64] ○ ○ ○ × × ○
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8) [Rounding]
If there is a numerical value that have digits to the right of the digit set for [Digits (Fractional)], select the processing 
method.
The following shows the items to be selected.

• [Round off]
• [Round down]
• [Round up]

9) [Digits (Integral)]
This item is displayed when [Fixed] is selected for [Digits (Fractional)].
Set the number of digits of the integer part to be displayed.
The number of the digits that can be set depends on the setting for [Format].

• [Signed Decimal] or [Unsigned Decimal]: [1] to [21]
• [Hexadecimal]: [1] to [16]
• [Octal]: [1] to [6]
• [Binary] or [Real]: [1] to [32]

10) [Display Digits]
This item is displayed when [Real] is selected for [Digits] and [Device] is selected for [Digits (Fractional)].
Set the total number of digits of the integer part and fractional part to be displayed.
The setting range is [1] to [32].

11) [Digits (Fractional)]
This item is displayed when [Real] is selected for [Format].
Select a method to specify the number of decimal places, and specify the number of decimal places to be displayed.
The following shows selectable items.

• [Fixed]:

[Real(32bit)] ○ ○ ○ × ○ ○

[Real(64bit)] ○ ○ ○ × × ○

Item Description

[Fill with 0]

When the right justification is set for [Alignment], 0 is prefixed to the numerical value.
Example): When setting [5] for [Digits (Integral)]

When [Format] is set to [Binary], the GOT displays the numerical value prefixed with 0, regardless of the 
setting of [Fill with 0].

[Show "+"]
When the numerical value is positive number, [+] is prefixed to the numerical value.
This item can be set only when [Format] is either [Signed Decimal] or [Real].

[Include signs in the integer 
portion]

A sign is included as one digit in the number of digits of the integer part.
This item can be set only when [Format] is either [Signed Decimal] or [Real].

Item Description

[Fill with 0]

When the right justification is set for [Alignment], 0 is prefixed to the numerical value.
Example): When setting [5] for [Display Digits]

[Show "+"] When the numerical value is positive number, [+] is prefixed to the numerical value.

[Include signs in the display 
digits] Includes a sign as one digit in the number of digits displayed.

[Data Type]
[Format]

[Signed Decimal] [Unsigned 
Decimal] [Hexadecimal] [Octal] [Binary] [Real]

5 00005

If prefixed with 0If not prefixed with 0

5 00005

If prefixed with 0If not prefixed with 0
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Enter the number of decimal places.
The setting range is [0] to [30].

• [Device]:
Set a device to specify the number of decimal places.
The number of decimal places changes based on the device value.
The data type of the device is unsigned 16-bit binary.
Set the device value as follows.
X > Y + 1
X: Value set for [Display Digits]
Y: Device value to specify the number of decimal places
If the device value is outside the valid range, 0 is assumed.

12) [Display Range]
Displays the maximum/minimum value which can be displayed on the screen.

13) [Display the numerical value to be shown on the screen with asterisk]
Displays the numerical value, sign, and decimal point to be displayed on the screen in asterisk.
This item can be set when [Font] is set to one other than [TrueType Numerical Gothic] and [TrueType Numerical 
7seg].
The character string (except #) set for [Format String] is not displayed in asterisk.
When saved as an operation log, the text is saved not as an asterisk but as a numerical value.

14) [Format String]
Displays characters (such as alphanumeric characters, kanji, or symbols) in the numerical display
This item can be set when [Font] is set to one other than [TrueType Numerical Gothic] and [TrueType Numerical 
7seg].
Enter #s to the positions where the digits of a numerical value are to be displayed.
The #s entered in setting this item are replaced with the digits of the device value.
Each # is replaced with the digit of the value in the same position counted from the right. If the number of the digits 
of the device value is larger than that of #s, the digits overflowing from the left are not displayed.
The digits of a real number to the right of the decimal point are processed according to the setting for [Rounding].
The sign included in the device value is also processed in the same way that processes the numerical value.
The following shows examples of displays.
Example 1) When the setting for [Format] is not [Real]

Item Description

[Adjust Decimal Point Range]

(When a value other than binary floating values is held in the monitor target device) the integer device 
value is displayed as a value with the decimal point.
This item can be set when [Format] is [Real] and [Data Type] is set to one other than [Real].

This setting is applied to the monitored device value and the following device values.
• Device values specified for [$V] and [Other Device] that are used in the expression for the display range 

in the [Style] tab
• Device values specified to [$W] and [Other Device] that are used in the expression for the input range 

in the [Input Case] tab
• Device values specified to [$$], [$W], and [Other Device] that are used in the expression for a data 

operation in the [Operation/Script] tab

[Format String] [Digits (Fractional)] Device value Display

##m##cm -

1234 12m34cm

123 1m23cm

12345 23m45cm

-123 -1m23cm

Example) Number of the digits to the right 
                of the decimal point: 2
                Controller device value: 20

Example) Number of the digits to the right 
                of the decimal point: 3
                Controller device value: 20

The value is displayed 
as 0.20 in the GOT.

The value is displayed 
as 0.020 in the GOT.

0.20 0.020
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Example 2) When setting [Real] for [Format] and [Round off] for [Rounding]

15) [Preview]
Displays the preview of the screen.

16) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(1) Items whose settings are invalid when the format text is used
• The settings of [Digits (Integral)] and [Display Digits] in the [Device] tab become invalid.
• The setting of [Alignment] in the [Device] tab becomes invalid and the right justification is performed.

(2) Characters which cannot be displayed in the format text
When [6x8dot] is set for [Font], and a character other than the ASCII cords (0x20 to 0x7E) is included in the 
format text, the character and all the following characters are not displayed.

➟12.6 ASCII Code List
(3) Operations performed when an input value is displayed at the input object position

When [Display input value on destination object location] is selected in the [Extended] tab, the input value 
of the key window is reflected on the object, according to the setting of [Format String].
However, in the following cases, the setting of [Format String] is not reflected to the display on the object 
while a value is being entered. Consequently, the value is displayed on the object in the set digits (the 
number of the pound signs [#]). (The decimal point is not counted as one digit.)

• The [Format] is set to [Binary] in the [Device] tab, and GS450.b6 is off.
• The [Format] is set to [Octal] in the [Device] tab, and GS450.b7 is off.
• The [Format] is set to [Real] in the [Device] tab.

To display the value on the object according to the setting of [Format String], confirm the entry.

[Format String] [Digits (Fractional)] Device value Display Description

##m##cm

0

12.345

m12cm Since [Digits (Fractional)] is 0, only the 
integer part is displayed.

2 12m35cm

Since [Digits (Fractional)] is 2, the digits 
from the integer part to the second 
decimal place are displayed.
The device value is rounded off to the 
third decimal place.

####cm 2
12.344 1234cm

Since [Digits (Fractional)] is 2, the 
device value is rounded off to the third 
decimal place.

12.345 1235cm

##.##cm 2
12.344 12.34cm

12.345 12.35cm

Item Description

[Preview Value] Set the numerical value to be displayed in the preview.
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

For the conditions, refer to the following.
➟6.5.5 Common setting for objects

1) Add button
Adds a new condition.

2) Delete button
Deletes the selected condition.

3) Up button, down button
Changes the order of priority of the selected condition.

4) Preview list
Displays set conditions.

5) [Utilize] button
Creates a new condition utilizing the selected condition.

6) [Range]
Set a device of the condition under which a display is changed.

➟6.5.5 ■2 Setting conditions
• [Bit]

Set the value of the bit device.
• [Range]

Set the word device value using a conditional expression.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3)

4)

6)

5)

7)

8)

9)
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7) [Common Setting]
These settings are applied to all the conditions to be set.

8) [Shape Attribute]

9) [Text Attribute]

Item Description

[Shape]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 Common setting for objects
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

Item Description

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

[Reverse] Inverts the color of the numerical value.

[Blink]

Select the blinking speed of the numerical value and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Data only]
• [Data and Shape]
These settings are applied to all the conditions to be set.

Item Description

[Numerical Color]
Set the color of the numerical value.
➟6.4 Color Settings

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

123456 123456
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■3 [Input case] tab

➟6.5.5 ■2 Setting conditions

1) Add button
Adds a new condition.

2) Delete button
Deletes the selected condition.

3) Up button, down button
Changes the order of priority of the selected condition.

4) Setting list
Displays the status set for each condition.

5) [Range]

Item Description

[Range] Set the range of the word device value for screen switching using a conditional expression.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3)

4)

5)
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].
Set a value greater than [Display] for [Input].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Display Mode]

Display mode when the numerical input is superimposed on a level object.
• [Transparent]: Displays the numerical value on the level object.

• [XOR]: The numerical value in a numerical display is integrated into the XOR synthesis with a level color, to be 
able to be distinguished from the level object.

As the setting is fixed to [Transparent], no additional setting is required accordingly.

The following shows the items to be selected.
• [Transparent]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)
5)

6)
7)
8)
9)

10)

11)
12) 13)

3)

98

20 5050

GOT Graphic Ver.2

GOT Graphic Ver.1
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• [XOR]
4) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].
The following operations can be performed when user ID numbers are set.

• Setting the position where the cursor is displayed at screen switching
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

• Checking the numerical input function that is displaying the cursor
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System 

Information])
• Specifying objects that were used with operation logs

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
For the details of this setting, refer to the following.

➟8.4.2 ■7 Specifying the destination to which the cursor moves after the confirmation of a numerical value 
entry

5) [Move Destination ID]
Set the user ID of a numerical input to which the cursor moves upon inputting a value.
To move the cursor by specifying a user ID, a cursor movement setting must also be configured.
Configure one of the following settings to enable the cursor movement per project or per screen.

• To enable the cursor movement per project
Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display the 
[Environmental Setting] window ([Key Window]), and select the [Advanced Setting] tab.

➟5.2.4 ■4 (2) [Advanced Setting] tab
Select [Control the cursor] for [Defined key action], and select one of the following items for [Cursor Move 
Destination].

• [In order of user ID]
• [Subsequently valid user ID] (Not available to GT21 and GS21)

• To enable the cursor movement only on the screen having a target numerical input
Click the [Screen Property] button to display the [Screen Property] dialog, and select the [Key Window 
Advanced Setting] tab.
(The [Screen Property] dialog corresponds to the screen having a target numerical input.)

➟2.7.1 Property of base screens
2.7.2 Properties of window screens

Select [Prioritize screen setting over project setting] in [Key Window/Cursor Movement].
Select [Control the cursor] for [Defined key action], and select one of the following items for [Cursor Move 
Destination].

• [In order of user ID]
• [Subsequently valid user ID] (Not available to GT21 and GS21)

6) [Display input value on destination object location]
Reflects the numerical values entered with the key window in the object on the screen immediately.
Write the value to a device after touching the enter key.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
8) [Write Device]

Set the target device where an input numerical value is to be written.
When the data operation is set, the data before the execution of the data operation can be stored.

9) [Write Check Device]
Set a bit device to turn on upon completion of a numerical input.

• [ON]
Turns on a set bit device upon completion of a numerical input.

• [ON and OFF]
Turns on a set bit device upon completion of a numerical input, and then turns off the bit device after a specified 
time period.
The setting range of the time period for which a set bit device is on is [5] x 100 ms to [30] x 100 ms.
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10) [Input data using Bar Code/RFID]
Inputs the numerical value read from a barcode reader or RFID.

➟10.1 Using a Barcode Reader with the GOT (Barcode Function)
10.2 Using an RFID with the GOT (RFID Function)

The following shows the items to be selected.
• [Bar Code]
• [RFID]

11) [KANJI region]
Select the KANJI region of the displayed text.
This item can be selected only when [Format String] is set in the [Device] tab.

➟1.2.5 Font specifications
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

12) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

13) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

Item Description

[Start Position]
Set the position of the byte from which a read value is input.
• [Bar Code]: [0] to [3997] byte(s)
• [RFID]: [0] to [19997] byte(s)

[Digits]
Set the number of digits for inputting the read data.
The same number of digits as that set for [Digits (Integral)] in the [Device] tab or smaller 
can be set.
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■5 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

For details of each item, refer to the following.
➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■6 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Depending on the selection for [Operation Type], the setting items are different.

(1) Data operation

This item can be set only when [Operation Type] is [Data Operation].
For the settings of the data operation function, refer to the following.

➟6.5.5 Common setting for objects

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Mask Type] Select a type of mask processing.
• [AND]: Logical AND

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]
• [Right]

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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3) [Data Operation]
Select the format of the expression operating with the data operation.

(2) Script (display)

When the [Script] and [Display] buttons are clicked, [Operation Type] can be set.
For the settings of scripts, refer to the following.

➟9.10 Object Script

Item Description

[Monitor]

Select the expression used when devices are monitored.
The following shows the items to be selected.
• [None]
• [Data Expression]

[Write]

Select the expression used when values are written to devices.
The following shows the items to be selected.
• [None]
• [Data Expression]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
*3 Not available when [Device] is selected for [Digits (Fractional)].

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device]

[Number Size] (width) text_width ○ ○ When the object is updated

[Number Size] (length) text_height ○ ○ When the object is updated

[Alignment] arrange ○ ○ When the object is updated

[Digits (Fractional)] decimal_point ○*3 ○*3 Upon the setting change

[Style]

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Numerical Color] text_color ○ ○ When the object is updated

[Extended]

[Security Level] ([Display]) security ○ ○ When the object is updated When the screen is updated

[Security Level] ([Input]) input_security ○ ○ Upon the setting change

[Display Mode] draw_mode ○ ○ ×
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(3) Script (input)

When the [Script] and [Input] buttons are clicked, [Operation Type] can be set.
For the settings of scripts, refer to the following.

➟9.10 Object Script

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
*3 Not available when [Device] is selected for [Digits (Fractional)].

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device]

[Number Size] (width) text_width ○ ○ When the object is updated

[Number Size] (length) text_height ○ ○ When the object is updated

[Alignment] arrange ○ ○ When the object is updated

[Digits (Fractional)] decimal_point ○*3 ○*3 Upon the setting change

[Style]

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Numerical Color] text_color ○ ○ When the object is updated

[Extended]

[Security Level] (display) security ○ ○ When the object is updated When the screen is updated

[Security Level] (input) input_security ○ ○ Upon the setting change

[Display Mode] draw_mode ○ ○ ×
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8.4.6 Relevant settings

Set the relevant settings other than the specific settings for the numerical display/input as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (key window), screen property
Set the following functions for each project (GOT environmental settings) or for each screen (screen property).

➟5.2.4 Setting key windows ([Key Window])
• Settings for each project (GOT environmental settings)

Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display the [Environmental 
Setting] window.

• Settings for each screen (screen property)
Select the screen editor on which the key window is to be set and select [Screen] → [Screen Property] from the menu 
to display the [Screen Property] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT 
Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

While entering a numerical value, checking the input range

Not available to GT21 and GS21.
This item is enabled only when an input range is set.
Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Check the input range while entering numerical values]

➟8.4.5 ■3 [Input case] tab

Displaying the allowable input range as a message when entering a numerical value 
outside the input range

Not available to GT21 and GS21.
Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Display the valid input range when an invalid value is 

input in Numerical Input]

Displaying the cursor when the operating condition is satisfied.

Not available to GT21 and GS21.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Cursor]

Deleting the key window and cursor when the operating condition is not satisfied.

Not available to GT21 and GS21.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Clear the key window and the cursor] of [When operating 

conditions are not satisfied]

Setting whether to move the display of the key window or not by screen
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window Position Correction]
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■3 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] window.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

Selecting when displaying the value being entered in the key window

Not available to GT21 and GS21.
Set the following item in the [Basic Setting] tab or [Key 
Window Basic Setting] tab.
• [Display value during input]

Selecting when displaying the input range of data in the key window

Not available to GT21 and GS21.
Set the following item in the [Basic Setting] tab or [Key 
Window Basic Setting] tab.
• [Display input function range]

Setting whether to display or hide the cursor when hiding the cursor and pressing the enter 
key or an arrow key

Not available to GT21 and GS21.
Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Display the cursor with a touch on the Enter/arrow key 

when the cursor is hidden]

When entering a value in a numerical input or text input, displaying a dialog for checking 
the input at a key touch operation on the enter key

Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Display the input confirmation dialog when setting the 

function of Numerical/ASCII Input]

Displaying the key window when the operating condition is satisfied.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window]

Displaying the key window when the screen is switched
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Display the key window]

Displaying the cursor when the screen is switched.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Display the cursor]

Selecting the method of displaying the cursor when entering a value with a numerical input 
or text input

Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Cursor Type]

Displaying the key window at a touch input or deleting the key window by touching the enter 
key

Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window]
• [Defined key action]

When multiple numerical inputs or text inputs exist, setting the order of input
After an entry is complete, moving the cursor to the next destination automatically

Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Defined key action]
• [Reference for determining cursor destination]

Setting the window screen to be used as a key window for numerical inputs (decimal or 
hexadecimal) and text inputs

Set the following item in the [Basic Setting] tab or [Key 
Window Basic Setting] tab.
• [Key Window]

Function Setting item

Function Setting item

When deleting the cursor, clearing the cursor information, such as the cursor display object 
ID and cursor display user ID [Clear the cursor information when deleting the cursor]

Notifying the value (32 bits) before a change with the numerical input function (Write 
device) [Previous Numeric Value Input(32bit)]

Notifying the value (32 bits) confirmed with the numerical input function (Write device) [Current Numeric Value Input(32bit)]

Notifying the confirmation of an entry from a numerical input (Write device: System signal 
2-1.b4) [System Signal 2-1]

Notifying the user ID of the numerical input to which an entry is confirmed (Write device) [Numeric Value Input Number]

Notifying the object ID No. of the object for which the cursor was previously displayed
(Write device) [Previous Cursor Display Object ID]

Notifying the user ID No. of the object for which the cursor had been displayed previously
(Write device) [Previous Cursor Display User ID]
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■4 GOT Internal Device
➟12.1.3 GOT special register (GS)

Notifying the key codes set to the input keys when the keys are input to text input, touch 
switch, or other objects (Write device)

[Key Code Input]
(Not available to GT21 and GS21)

Notifying that the key window is being displayed (Write device: System signal 2-1.b11) [System Signal 2-1]

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Turning off the Numeric Value Input signal (Read device: System signal 1-1.b4) [System Signal 1-1]

Notifying the object ID No. of the object for which the cursor is currently being displayed
(Write device) [Current Cursor Display Object ID]

Notifying the user ID No. of the object for which the cursor is being displayed currently
(Write device) [Current Cursor Display User ID]

Notifying the cursor is being displayed in a numerical value or text input
(Write device: System signal 2-2.b11) [System Signal 2-2]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

Notifying a value out of the input range is stored
(Write device: System signal 2-1.b14)

[System Signal 2-1]
(Not available to GT21 and GS21)

Function Setting item

Function Setting item

Notifying that the object is ready for receiving an input from the barcode reader or RFID
GS243.b15
(Not available to GT21 and GS21)

When entering a value or text with a numerical input or text input object, displaying a dialog 
prompting you to confirm the entry when the enter key is touched

GS450.b0
(Not available to GT21 and GS21)

Checking the input range while entering a value for a numerical input object
GS450.b1
(Not available to GT21 and GS21)

Storing 0 in the current cursor position device and other related devices of the system 
information when the cursor is hidden.

GS450.b3
(Not available to GT21 and GS21)

Displaying the key window for inputting binary values when the format of the numerical 
input is binary

GS450.b6
(Not available to GT21 and GS21)

Displaying the key window for inputting octal values when the format of the numerical input 
is octal

GS450.b7
(Not available to GT21 and GS21)

Notifying the upper-left coordinates of a numerical input object on which the cursor is 
displayed

GS694
GS695
(Available to GT27, GT25, and GS25)
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8.5 Placing a Text Display and Text Input

■1 Text Display
Data in a word device is handled in a specified character code and displayed as text.

■2 Text Input
This function writes a character string into word devices.

(1) Entering characters with keys for entries
As keys for entries, a key window and touch switches to which key codes are assigned are available.

(a) Entering with touch switches placed on the screen

(b) Entering from a key window
➟5.2.4 Setting key windows ([Key Window])

(2) Inputting text with a barcode reader or RFID
➟10.1 Using a Barcode Reader with the GOT (Barcode Function)

10.2 Using an RFID with the GOT (RFID Function)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10
D11
D12
D13
D14

4F8Eh
4895h
5851h
3420h
0030h

(XQ)
(4  )
(0)

D10
D11
D12
D13
D14

4F8Eh
4895h
5851h
3420h
0032h

(XQ)
(4  )
(2)

QX 40 QX 42

DELEA B C D GF
- ESCH I J K

ABC

DELEA B C D GF
- ESCH I J K

ABCD

ABC ABCD

D10
D11

(BA)
(DC)

4241h
4443h

D10
D11

0000h
0000h

Entering characters Enter the input characters by the character code
using the input key (key code: 000Dh).

Text is input in the 
touched text input.Barcode reader

DELEA B C D GF
- ESCH I J K

ABCDE

Barcode

ABCDE
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8.5.1 Specifications of the text display and text input

■1 Maximum number of objects arrangeable on one screen
The maximum number of objects on one screen depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 1024 text displays and text inputs can be placed on one screen.

• For GT21 and GS21
Up to 1024 text displays can be placed on one screen.
Up to 100 text inputs can be placed on one screen.

■2 Kana-Kanji/Pinyin Conversion
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
For the Kana-Kanji/Pinyin conversion, refer to the following.

➟5.2.13 Configuring the settings to convert a text into kanji or Simplified Chinese characters in the GOT 
([Kana-Kanji/Pinyin Conversion])

■3 Supported character code
The following character codes are supported.

• ASCII code
• Unicode (UTF-16)
• Shift JIS code
• GB code

• KS code*1

• Big5 code
*1  Not available to GT21 and GS21.

■4 Number of monitored devices and number of digits to be displayed
The number of monitored devices depends on the device data type, character code, and the number of digits to be 
displayed.

*1 For a text display, the lower- or higher-order bytes of the last device are not monitored.
Whether the lower- or higher-order bytes are not monitored depends on the display order of the string data.

• High to low: Lower-order bytes of the last device
• Low to high: Higher-order bytes of the last device

*2 For a text input, a null or space selected for [Input Character String Terminal] is inserted to the lower- or higher-order bytes 
of the last device.
The position of insertion depends on the storage order of the string data.

• High to low: Lower-order bytes of the last device
• Low to high: Higher-order bytes of the last device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device data type Character code The number of monitored devices

16-bit

ASCII code
Shift JIS code
GB code
KS code
Big5 code

One word device is used for two digits to be displayed.
If an odd number of digits is displayed, the odd number incremented by 1 is the number of monitored 
devices.*1*2

Example) Number of digits to be displayed: 3, start device: D1000
Two word devices (D1000 and D1001) starting from D1000 are used.

Unicode (UTF-16)
One word device is used for one digit to be displayed.
Example) Number of digits to be displayed: 3, start device: D1000
Three word devices (D1000 to D1002) starting from D1000 are used.

8-bit

ASCII code
Shift JIS code
GB code
KS code
Big5 code

Eight bit devices are used for one digit to be displayed.
Example) Number of digits to be displayed: 3, start device: GB1000
Twenty-four consecutive devices (GB1000 to GB1023) starting from GB1000 are used.

Unicode (UTF-16)
Sixteen bit devices are used for one digit to be displayed.
Example) Number of digits to be displayed: 3, start device: GB1000
Forty-eight consecutive devices (GB1000 to GB1047) starting from GB1000 are used.
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■5 Order of displaying and storing character strings
You can specify the order of displaying the character strings stored in devices and the order of storing character strings 
in devices.
The following shows the specifications of each character code.

(1) ASCII code, shift JIS code, GB code, KS code, Big5 code
Specifications differ depending on the data type.

• When the data type is 16-bit
Low to high or high to low can be specified.
b8 to b15 of a word device are handled as the higher-order bytes, and b0 to b7 as the lower-order bytes.

• When the data type is 8-bit
Only low to high can be specified.
When the start device is GB1000, GB1008 to GB1015 are handled as the higher-order bytes, and GB1000 to 
GB1007 as the lower-order bytes.

Example) Storing 16 bit string data in D1000 to D1001

Display order and 
storage order Specifications

Low to high

Example) Character code: Shift JIS code

Higher: b8 to b15, lower: b0 to b7

High to low

Example) Character code: Shift JIS code

Higher: b8 to b15, lower: b0 to b7

D1000

D1001

4F 8E

48 95

String:

String data: 0x8E4F 0x9548

High Low

D1000

D1001

8E 4F

95 48

String:

String data: 0x8E4F 0x9548

High Low
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(2) Unicode
Specifications differ depending on the data type and GOT model.

• When the data type is 16-bit
Low to high or high to low can be specified.
b8 to b15 of a word device are handled as the higher-order bytes, and b0 to b7 as the lower-order bytes.

• When the data type is 8-bit
Low to high or high to low can be specified.
When the start device is GB1000, GB1032 to GB1063 are handled as the higher-order bytes, and GB1000 to 
GB1031 as the lower-order bytes.

Example) Storing 16 bit string data in D1000 to D1001

Display order and 
storage order

Specifications

GT27, GT25, GT23, GT SoftGOT2000, GS25 GT21, GS21

Low to high

Higher: b8 to b15, lower: b0 to b7 Higher: b8 to b15, lower: b0 to b7

High to low

Higher: b8 to b15, lower: b0 to b7 Higher: b8 to b15, lower: b0 to b7

D1000

D1001

09 4E

F1 83

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

4E 09

83 F1

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

4E 09

83 F1

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

09 4E

F1 83

String:

String data: 0x4E09 0x83F1

High Low
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8.5.2 How to use the text display and text input

■1 Placing the text display and text input
Place text displays and text inputs on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing text displays and text inputs
Edit text displays and text inputs that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting text displays and text inputs
Set text displays and text inputs that have been placed on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Text display settings
➟8.5.4 [Text Display] dialog

• Text input settings
➟8.5.5 [Text Input] dialog

■4 Entering with a key window placed on a base screen.
When key code switches are placed on a base screen and are used, text can be entered without the display of a key 
window.
For key code switches, refer to the following.

➟8.2.11 [Key Code Switch] dialog

■5 Action examples of text displays and text inputs
The following shows the examples of displaying and inputting the Shift JIS code on GT27.
Example 1)
When the shift JIS code 8E4h (MITSU) and 9548 (BISHI) are displayed in the order of lower byte to upper byte in the text 
display
Setting device: D1
Number of displayed digits: 3

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Not displayed.L

H

L

H

D1

D2

8Eh

4Fh

95h

48h

Set device Text display

L: Lower byte
H: Upper byte
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Example 2)
When the shift JIS code 8E4h (MITSU) and 9548 (BISHI) are written in the order of lower byte to upper byte in the text 
input
Setting device: D1
Number of displayed digits: 3

■6 Inputting texts using a barcode reader or RFID
Texts can be input using a barcode reader or RFID.
When inputting texts from a barcode reader or RFID, set the barcode function or RFID function.

➟10.1 Using a Barcode Reader with the GOT (Barcode Function)
10.2 Using an RFID with the GOT (RFID Function)

■7 Specifying the destination to which the cursor moves after the confirmation of a text entry
When [User ID] is set, the destination to which the cursor moves after the confirmation of a text entry can be specified.
[User ID] can be set only when texts are used.

➟8.5.5 ■2 [Extended] tab

(1) About [User ID]
When [User ID] is set, the following setting and operations are enabled.

• Setting the position where the cursor is displayed at screen switching
➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

• Specifying objects that were used with operation logs
Not available to GT21 and GS21.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
• Moving the cursor in ascending or descending order of user ID number

➟(a) Moving the cursor in ascending or descending order of user ID number

(a) Moving the cursor in ascending or descending order of user ID number
When the following key code switches are used, the cursor can be moved in ascending or descending order of user ID 
number.

• User ID ascending order movement of cursor (key code: 0092h)

The cursor is moved in order of 1) → 2) → 3).
After 3), the cursor does not move because the destination user ID number does not exist.

The error is displayed.
No input is available.

L

H

L

H

D1

D2

Set device Text input

Key code 4F8E h 4895 h

8Eh

4Fh

(Values are
not stored.)

L: Lower byte
H: Upper byte

20h (space)

User ID: 1 User ID: 2

User ID: 2User ID: 3

1)

2) 3)

The user ID is duplicated. The cursor is not moved. 
If the user ID is duplicated, the cursor is moved to 
the object whose object ID is the minimum.

User ID: 4

GHI

DEF

DEF

JKL

CAB
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• User ID descending order movement of cursor (key code: 0093h)

The cursor is moved in order of 1) → 2) → 3).
After 3), the cursor does not move because the destination user ID number does not exist.

(2) User ID setting
When controlling the cursor using user ID numbers, assign different user ID numbers to each object.
Also, when using overlay screens or superimpose windows, set screens in a way that different user ID numbers are 
assigned to each object.
When the same user ID number is assigned to different objects, the cursor operation may not perform normally.

• When assigning different user ID numbers to each object
Even when overlay screens or superimpose windows are used, the cursor operation using user ID numbers is 
performed normally.

• When assigning the same user ID number
If objects which have the same user ID exist on the screen (including set overlay screens and superimpose windows), 
the cursor operation using user ID numbers may not perform normally.

User ID: 1 User ID: 2

User ID: 2User ID: 3

3)

2) 1)

The user ID is duplicated. The cursor is not moved. 
If the user ID is duplicated, the cursor is moved to 
the object whose object ID is the minimum.

User ID: 4

GHI

DEF

DEF

ABC

LJK

to : User ID
C

D GHI

CABA

B JKM

DEF

Base screen 1

Window screen 1
12

3 4

1 4

to : User ID
C

D GHI

CABA

B JKM

DEF

Base screen 1

Window screen 1
1

2

2
1

2

1
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(3) The relation between user ID and destination ID
The destination ID number indicates the user ID number of the text input where the cursor is moved next.

➟8.5.5 ■2 [Extended] tab
Example) Moving the cursor using the destination ID number

A

C

B

D

1)

2)

3)
4)

Numerical input User ID Destination ID

A 1 2

B 2 3

C 3 4

D 4 1

User ID: 1 User ID: 2

User ID: 3 User ID: 4

GHI

DEF

JKL

CAB
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8.5.3 Precautions for a text display object and a text input object

■1 When the unavailable ASCII code is stored
If the following ASCII code is included in the target data of the text display, the text that is after the ASCII code is not 
displayed.

• 0000h to 001Fh
• 0080h
• 00F0h to 00FFh

Example) When the control code 09h (Tab) is included

■2 About system message and text display and text input
Depending on the language set in the system message, the character code to be displayed is different.

• Other than English: shift JIS code
• English: ASCII code

The Kana character or others are not displayed for ASCII code.

■3 Blink
The blink of the text display is paused when the input cursor is displayed.

■4 Characters displayable in the HQ fonts
The following characters are displayable in the HQ fonts on the text display or the text input.

• HQ font characters that are registered in a comment group
• HQ font characters to be displayed on an object when [Text Type] is set to [Text]
• HQ font characters that are set for a text figure
• Alphanumeric characters
• Symbols (! " # $ % & ' ( ) : + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~)

If the text set to be displayed in an HQ font includes any character other than the above, the text is displayed in the 
corresponding standard font.

■5 When using a barcode reader or RFID
(1) Reading data from a barcode reader or RFID while entering texts in the key window

Depending on the operation, the read data may or may not be input as texts.
• While displaying dialog windows

The data read from a barcode reader or RFID cannot be input texts.
• While not displaying dialog windows

The text being input in the key window is dropped, and the data read from a barcode reader or RFID is input as text.

(2) Performing key touch operations while the data read from a barcode reader or RFID is in the process 
of being input
While the data read from a barcode reader or RFID is in the process of being input, key touch operations are invalid and 
the data read from a barcode reader or RFID is input.

(3) Under the specified start position
When the data read from a barcode reader or RFID is under [Start Position], the text input is not executed for the data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10
D11
D12

5851h
3409h
0030h

"X""Q"
"4""09h (Tab)"
"0"

The value "40" which is after the control code is not displayed.

(QX40)

Control code 09h (Tab)

QX 
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■6 When setting [ON and OFF] for [Write Check Device]
The setting of [Write Check Device] (write completion device) is available for a numerical input object as well.
If you specify a common write completion device for a numerical input object and a text input object, or for multiple text 
input objects, note the following points.

(1) Number of write completion devices that turn on simultaneously
Do not turn on 21 or more write completion devices simultaneously.
Otherwise the write completion devices that turn on 21st and later do not turn off automatically.

(2) When specifying a common write completion device for multiple text input objects
Set trigger conditions to prevent data entry into a target input object while the common write completion device is on for 
another target input object.
Example) Setting [Write Check Device] to M10 and [Trigger Type] to [OFF]

If you enter data into a target input object while the common write completion device is on for another target input object, 
the common write completion device does not turn off at the appropriate time.
Example) When entering data into text input A while the common write completion device is on for text input B

(3) Operations performed at screen switching
Even when screen switching (including switching to utilities) occurs while a write completion device is on, the write 
completion device does not turn off.
The device remains on until a set time elapses.

■7 Character code setting when using a string-type label or tag
If you set a label or tag for the device of an object, set the character code according to the type of the label or tag.

• System label Ver.1: ASCII code or Shift JIS code
• System label Ver.2 and global label: ASCII code, Unicode, or Shift JIS code
• OMRON NJ/NX tag: Unicode
• AB native tag: ASCII code
• OPC UA tag: Unicode

Text input A

Text input B

Write completion
device: (M10)

Turn-off timing of the device for text input B
Actual turn-off timingON

OFF

3 seconds

C D

A B
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8.5.4 [Text Display] dialog

Step 1 Select [Object] → [Text Display/Input] → [Text Display] from the menu.
Step 2 Click the position where you place the text display. Placing the text display is complete.
Step 3 Double-click the text display which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Device/Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Text Display]
• [Text Input]

2) [Device]
Set the start device to be monitored.

➟6.1.2 How to set devices
The number of monitored devices depends on the setting.
For details, refer to the following.

➟8.5.1 ■4 Number of monitored devices and number of digits to be displayed
3) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Unsigned BIN16]
• [Unsigned BIN8]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
4)

5)

9)

6)

7) 8)

3)
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4) [Digits]
Set the text digits to be displayed.
The setting range is [1] to [100].
A one-byte character is counted as one digit, and a two-byte character is counted as two digits.

5) [Alignment]
Set the horizontal position of the text.

6) [Text Settings]

Item Description

[Character Code]

Select the character code of the text to be displayed.
The following shows the items to be selected.
• [System Language Link]
• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]
When [System Language Link] is selected, the text is displayed by the following character 
codes according to the system language.
• When the system language is English

ASCII code is used.
• When the system language is Chinese (Simplified) and the conversion method for the 

Kana-Kanji/Pinyin conversion function is [Pinyin Simplified Characters]
GB code is used.

• Other than the above
S-JIS code is used.

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Text Size]
Set the text size to be displayed.

➟1.2.5 Font specifications

[Text Color]
Set the text color.

➟6.4 Color Settings

[Reverse] Inverts the text.

[Display the text to be shown on the screen 
with asterisk]

Displays the text to be displayed on the screen with asterisk.
When saved as an operation log, the text is saved not as an asterisk but as a text.

[Blink]

Select the blinking speed of the text and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Text only]
• [Text and Shape]
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7) [Shape Settings]

8) [Preview]
Displays the preview of the screen.

9) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Shape Settings]

Select the shape to be set for the object from the list or with the [Shape] button.

➟6.5.5 ■1 Setting object shapes
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.

➟6.4 Color Settings

[Shape Color]
Select the color of the shape.

➟6.4 Color Settings

Item Description

[Text] Set the text to be displayed in the preview.

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

ABCDE ABCDE
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■2 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Sets the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Display in order of High -> Low]

Select this item to display string data stored in devices in order of lower byte to upper byte.
For details, refer to the following.

➟8.5.1 ■5 Order of displaying and storing character strings
4) [KANJI Region]

When [Unicode] is selected for [Character Code], select a KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

5) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

6) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

5) 6)
4)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device/Style]

[Alignment] arrange ○ ○ When the object is updated

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Text Color] text_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.5.5 [Text Input] dialog

Step 1 Select [Object] → [Text Display/Input] → [Text Input] from the menu.
Step 2 Click the position where you place the text input. Placing the text input is complete.
Step 3 Double-click the text input which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Device/Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Text Display]
• [Text Input]

2) [Device]
Set the start device to be monitored.

➟6.1.2 How to set devices
The number of monitored devices depends on the setting.
For details, refer to the following.

➟8.5.1 ■4 Number of monitored devices and number of digits to be displayed
3) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Unsigned BIN16]
• [Unsigned BIN8]

4) [Digits]
Set the text digits to be displayed.
The setting range is [1] to [100].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
4)
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A one-byte character is counted as one digit, and a two-byte character is counted as two digits.
5) Alignment

6) [Input Character String Terminal]
If the number of input characters is less than the number of characters specified in [Digits] of the [Device/Style] tab, 
you can select the ASCII code to be inserted to the lacked part.
The following shows the items to be selected.

• [Space (0x20)]:
Insert the space (0x20) to reserve it as a space.
Reentering text deletes the inserted space, and confirming the entry inserts a space.
This item can be selected only when the left alignment is selected in [Display Alignment].
Example) When the entered text has three digits with [7] set in [Digits]

• [NULL (0x00)]:
Insert NULL(0x00) as the first character of the lacked part.
The characters before NULL are enabled, and the characters after NULL are ignored because they are 
indefinite.
The controller is enabled to detect the text end.
Example) When the entered text has three digits with [7] set in [Digits]

7) [Text Settings]

Item Description

[Display Alignment] Select the horizontal position of the text to be displayed.

[Input Alignment] Select the horizontal position of the text to be entered.

Item Description

[Character Code]

Select the character code of the text to be displayed.
The following shows the items to be selected.
• [System Language Link]
• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]
When [System Language Link] is selected, the text is displayed by the following character 
codes according to the system language.
• When the system language is English

ASCII code is used.
• When the system language is Chinese (Simplified) and the conversion method for the 

Kana-Kanji/Pinyin conversion function is [Pinyin Simplified Characters]
GB code is used.

• Other than the above
S-JIS code is used.

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

Text

ASCII code

A B C

(0x41) (0x42) (0x43) (0x20) (0x20) (0x20)

(SP)(SP) (SP)

(0x20)

(SP)

(0x0)

-(NULL)Text

ASCII code

A B C

(0x41) (0x42) (0x43) - -

-

-

-
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*1 The following shows the number of asterisks to be displayed.

8) [Shape Settings]

9) [Preview]
Displays the preview of the screen.

10) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Text Color]
Set the text color.
➟6.4 Color Settings

[Reverse] Inverts the text.

[Display the text to be shown on the screen 
with asterisk]

When saved as an operation log, the text is saved not as an asterisk but as a text.
When this item is selected, Kana-Kanji/Pinyin conversion is not available.
Even turning on GS450.b4 does not activate Kana-Kanji/Pinyin conversion.
Displays the text and control character (other than NULL) to be displayed on the screen 
with asterisk.
The control character is also displayed with asterisk.
Depending on the setting of [Input Character String Terminal], the number of displayed 
asterisks is different.*1

➟12.1.3 GOT special register (GS)

[Blink]

Select the blinking speed of the text and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Text only]
• [Text and Shape]

Setting of Input Character String 
Terminal

Display without display setting of 
asterisk Display with display setting of asterisk

Space (0x20) ******

NULL (0x00) ABCD ****

Item Description

[Shape Settings]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 Common setting for objects
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

Item Description

[Text] Set the text to be displayed in the preview.

Item Description

ABCD

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

ABCDE ABCDE
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■2 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].
Set a value greater than [Display] for [Input].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Sets the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Display in order of High -> Low]

Select this item to display string data stored in devices in order of lower byte to upper byte.
For details, refer to the following.

➟8.5.1 ■5 Order of displaying and storing character strings
4) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].
The following operations can be performed when user ID numbers are set.

• Setting the position where the cursor is displayed at screen switching
➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

• Specifying objects that were used with operation logs
➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])

• Moving the cursor in ascending or descending order of user ID number
➟8.4.2 ■7 Specifying the destination to which the cursor moves after the confirmation of a numerical 

value entry

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)
5)

6)
7)

12) 13)

8)

9)

11)

10)
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5) [Move Destination ID]
Set the user ID of a text input to which the cursor moves upon inputting text.
To move the cursor by specifying a user ID, a cursor movement setting must also be configured.
Configure one of the following settings to enable the cursor movement per project or per screen.

• To enable the cursor movement per project
Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display the 
[Environmental Setting] window ([Key Window]), and select the [Advanced Setting] tab.

➟5.2.4 ■4 (2) [Advanced Setting] tab
Select [Control the cursor] for [Defined key action], and select one of the following items for [Cursor Move 
Destination].

• [In order of user ID]
• [Subsequently valid user ID] (Not available to GT21 and GS21)

• To enable the cursor movement only on the screen having a target text input
Click the [Screen Property] button to display the [Screen Property] dialog, and select the [Key Window 
Advanced Setting] tab.
(The [Screen Property] dialog corresponds to the screen having a target numerical input.)

➟2.7.1 Property of base screens
2.7.2 Properties of window screens

Select [Prioritize screen setting over project setting] in [Key Window/Cursor Movement].
Select [Control the cursor] for [Defined key action], and select one of the following items for [Cursor Move 
Destination].

• [In order of user ID]
• [Subsequently valid user ID] (Not available to GT21 and GS21)

6) [Display input value on destination object location]
Reflects the texts entered with the key window in the object on the screen immediately.
Write the value to a device after touching the enter key.

7) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
8) [Write Check Device]

Set a bit device to turn on upon completion of a text input.
• [ON]

Turns on a set bit device upon completion of a text input.
• [ON and OFF]

Turns on a set bit device upon completion of a text input, and then turns off the bit device after a specified time 
period.
The setting range of the time period for which a set bit device is on is [5] x 100 ms to [30] x 100 ms.

9) [Kana-Kanji/Pinyin Conversion]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Kana-Kanji/Pinyin conversion is available.
When [Display the text to be shown on the screen with asterisk] is set in the [Device/Style] tab, this function cannot 
be set.

10) [Input data using Bar Code/RFID]
Inputs the text read from a barcode reader or RFID.

➟10.1 Using a Barcode Reader with the GOT (Barcode Function)
10.2 Using an RFID with the GOT (RFID Function)

The following shows the items to be selected.
• [Bar Code]
• [RFID]

Item Description

[Start Position]
Set the position of the byte from which a read value is input.
• [Bar Code]: [0] to [3997] byte(s)
• [RFID]: [0] to [19997] byte(s)
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11) [KANJI Region]
When [Unicode] is selected for [Character Code], select a KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

12) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

13) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]

[Number of Digits]
Set the number of digits for inputting the read data.
The same number of digits as that set for [Digits (Integral)] in the [Device] tab or smaller 
can be set.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)
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• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

■4 [Script] tab

(1) Script (display)
This item can be set when the [Display] button is clicked.
For the settings of scripts, refer to the following.

➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

(2) Script (input)
This item can be set when the [Input] button is clicked.
For the settings of scripts, refer to the following.

➟9.10 Object Script

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device/Style]

[Alignment] arrange ○ ○ When the object is updated

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Text Color] text_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended]
[Security Level] (display) security ○ ○ When the object is updated When the screen is updated

[Security Level] (input) input_security ○ ○ Upon the setting change
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(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device/Style]

[Alignment] arrange ○ ○ When the object is updated

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Text Color] text_color ○ ○ When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended]
[Security Level] (display) security ○ ○ When the object is updated When the screen is updated

[Security Level] (input) input_security ○ ○ Upon the setting change
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8.5.6 Relevant settings

Set the relevant settings other than the specific settings for the text display and text input as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (key window), screen property
Set the following functions for each project (GOT environmental settings) or for each screen (screen property).

➟5.2.4 Setting key windows ([Key Window])
• Settings for each project (GOT environmental settings)

Select [Common] → [GOT Environmental Setting] → [Key Window] from the menu to display the [Environmental 
Setting] window.

• Settings for each screen (screen property)
Select the screen editor on which the key window is to be set and select [Screen] → [Screen Property] from the menu 
to display the [Screen Property] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT 
Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Displaying the key window when the operating condition is satisfied.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window]

Displaying the key window when the screen is switched
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Display the key window]

Displaying the cursor when the screen is switched.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Display the cursor]

Displaying the cursor when the operating condition is satisfied.

Not available to GT21 and GS21.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Cursor]

Deleting the key window and cursor when the operating condition is not satisfied.

Not available to GT21 and GS21.
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Clear the key window and the cursor] of [When operating 

conditions are not satisfied]

Selecting the method of displaying the cursor when entering a value with a numerical input 
or text input

Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Cursor Type]

Displaying the key window at a touch input or deleting the key window by touching the enter 
key

Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window]
• [Defined key action]
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■3 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] window.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

When multiple numerical inputs or text inputs exist, setting the order of input
After an entry is complete, moving the cursor to the next destination automatically

Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Defined key action]
• [Reference for determining cursor destination]

Setting the window screen to be used as a key window for numerical inputs (decimal or 
hexadecimal) and text inputs

Set the following item in the [Basic Setting] tab or [Key 
Window Basic Setting] tab.
• [Key Window]

Setting whether to move the display of the key window or not by screen
Set this function in the following item in the [SP Function] 
tab and [Key Window Advanced Setting] tab.
• [Key Window Position Correction]

Setting whether to display or hide the cursor when hiding the cursor and pressing the enter 
key or an arrow key

Not available to GT21 and GS21.
Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Display the cursor with a touch on the Enter/arrow key 

when the cursor is hidden]

When entering a value in a numerical input or text input, displaying a dialog for checking 
the input at a key touch operation on the enter key

Display the [Display Detail Setting] dialog with the [Setting] 
button in the [Advanced Setting] tab or [Key Window 
Advanced Setting] tab to set this function with the following 
item.
• [Display the input confirmation dialog when setting the 

function of Numerical/ASCII Input]

Function Setting item

Function Setting item

Outputting the input signal, input number, or others to the system information when the text 
input is executed

[Output object ID of Text Input to the system information 
device]

When deleting the cursor, clearing the cursor information, such as the cursor display object 
ID and cursor display user ID [Clear the cursor information when deleting the cursor]

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Turning off the Numeric Value Input signal (Read device: System signal 1-1.b4) [System Signal 1-1]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

Notifying the confirmation of an entry from a numerical input (Write device: System signal 
2-1.b4) [System Signal 2-1]

Notifying that the key window is being displayed
(Write device: System signal 2-1.b11) [System Signal 2-1]

Notifying the cursor is being displayed in a numerical value or text input
(Write device: System signal 2-2.b11) [System Signal 2-2]

Notifying the user ID of the numerical input to which an input is confirmed (Write device) [Numeric Value Input Number]

Notifying the object ID No. of the object for which the cursor is currently being displayed
(Write device) [Current Cursor Display Object ID]

Notifying the object ID No. of the object for which the cursor was previously displayed
(Write device) [Previous Cursor Display Object ID]

Notifying the user ID No. of the object for which the cursor is being displayed currently
(Write device) [Current Cursor Display User ID]

Notifying the user ID No. of the object for which the cursor had been displayed previously
(Write device) [Previous Cursor Display User ID]

Notifying the key codes set to the input keys when the keys are input to text input, touch 
switch, or other objects
(Write device)

[Key Code Input]
8 - 288 8. OBJECT FUNCTION
8.5 Placing a Text Display and Text Input



8

O
B

JE
C

T 
FU

N
C

TI
O

N

■4 GOT Internal Device
➟12.1.3 GOT special register (GS)

Function Setting item

Notifying that the object is in the ready state for the data read by the barcode reader and the 
RFID to be directly input.

GS243.b15
(Not available to GT21 and GS21)

When entering a value or text with a numerical input or text input object, displaying a dialog 
prompting you to confirm the entry when the enter key is touched.

GS450.b0
(Not available to GT21 and GS21)

Storing 0 in the current cursor position device and other related devices of the system 
information when the cursor is hidden.

GS450.b3
(Not available to GT21 and GS21)

Converting the hiragana characters or Pinyin characters entered with a text input object into 
kanji characters or Simplified Chinese characters.

GS450.b4
(Only available to GT2107-W for GT21)
(Not available to GS21)

Changing the character code to be used for the text display and text input objects. GS456

Switching a key window for text input to a key window that supports Kana-Kanji conversion 
or Pinyin conversion.

GS467.b1
(Not available to GT23, GT21, and GS21)

Changing the KANJI region to be used for the text display and text input where [Character 
Code] is set to [Unicode]. GS468

Notifying the upper-left coordinates of the text input object on which the cursor is displayed.
GS694
GS695
(Available to GT27, GT25, and GS25)
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8.6 Placing a Date Display and Time Display

■1 Date Display
This function displays the date on the GOT.

■2 Time Display
This function displays the time on the GOT.

8.6.1 Specifications of the date display and time display

■1 Maximum number of objects arrangeable on one screen
The maximum number of objects on one screen depends on the screen type.

• For a base screen
Up to 1024 date displays and time displays can be placed on one screen.

• For a window screen
Up to 512 date displays and time displays can be placed on one screen.

■2 Date data and time data to be displayed
The date display and time display display the data of the GOT clock.
For the details of the GOT clock, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

13/12/25

13:48

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.6.2 How to use the date display and time display

■1 Placing the date display and time display
Place date displays and time displays on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing date displays and time displays
Edit date displays and time displays that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting date displays and time displays
Set date displays and the time displays that have been placed on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Date display settings
➟8.6.3 [DateDisplay] dialog

• Time display settings
➟8.6.4 [Time Display] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.6.3 [DateDisplay] dialog

Step 1 Select [Object] → [Date/Time Display] → [DateDisplay] from the menu.
Step 2 Click the position where you place the date display. Placing the date display is complete.
Step 3 Double-click the date display which has been placed to display the setting dialog.

➟■1 [Text/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Text/Style] tab

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Date]
• [Time]

2) [Display Format]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Sort]

Select a sorting order of year, month, and date.
When [Change the sort setting along with language switching] is selected, a sorting order 
cannot be selected.
The following shows the items to be selected.
• [yy/mm/dd]
• [mm/dd/yy]
• [dd/mm/yy]

[Delimiter]

Select a delimiter used for separating the year, month, and date.
The following shows the items to be selected.
• [/]
• [-]
• [.]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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[Date Type]

Select the display type of the date.
The items to be displayed differ depending on the selected item of [Delimiter] and [Fill with 
0].
The following shows the default items to be selected.
Example) To display Wednesday, December 25, 2013
• [13/12/25]
• [Dec/25]
• [DEC/25]
• [Dec/25(WED)]
• [DEC/25(WED)]
• [13/Dec/25]
• [13/DEC/25]
• [13/Dec/25(WED)]
• [13/DEC/25(WED)]
• [2013/Dec/25]
• [2013/DEC/25]
• [2013/Dec/25(WED)]
• [2013/DEC/25(WED)]
• [2013/12/25]
• [2013/12/25(WED)]
• [12/25]
• [12/25(WED)]
• [13/12/25(WED)]

• 

• 

• 

• 

• 

• 

• 

• 

• 

[Fill with 0] When the month and/or date are/is in single digit, zero is displayed before the single-digit 
number.

[Change the sort setting along with language 
switching]

Changes a sorting order of the date associating with language switching.
When the following items are selected in [Date Type], this function cannot be set.
• 

• 

• 

• 

• 

• 

• 

• 

• 

To use this function, set [Region Setting] in [Language Switching] of [Environmental 
Setting].
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

Item Description

[12月25日]
[12月25日(水)]
[13年12月25日]
[13年12月25日(水)]
[2013年12月25日]
[2013年12月25日(水)]
[12/25(水)]
[13/12/25(水)]
[2013/12/25(水)]

[12月25日]
[12月25日(水)]
[13年12月25日]
[13年12月25日(水)]
[2013年12月25日]
[2013年12月25日(水)]
[12/25(水)]
[13/12/25(水)]
[2013/12/25(水)]
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3) [Shape Settings]

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Numerical Gothic]
• [TrueType Numerical 7seg]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Text Color]
Set the text color.
➟6.4 Color Settings

Item Description

[Shape]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.4 Color Settings
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

Preview Displays the preview of the screen.

Item Description

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3
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■2 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Layer]

Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

3) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
8 - 296 8. OBJECT FUNCTION
8.6 Placing a Date Display and Time Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Text/Style]

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Text Color] text_color ○ ○ When the object is updated

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
8. OBJECT FUNCTION
8.6 Placing a Date Display and Time Display

8 - 297



8.6.4 [Time Display] dialog

Step 1 Select [Object] → [Date/Time Display] → [TimeDisplay] from the menu.
Step 2 Click the position where you place the time display. Placing the time display is completed.
Step 3 Double-click the time display which has been placed to display the setting dialog.

➟■1 [Text/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Text/Style] tab

1) [Item]
Select the function to be used.
The following shows the items to be selected.

• [Date]
• [Time]

2) [Display Format]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Time Type]

Select the display type of the time.
The display of the setting range differs depending on the selected item of [Fill with 0].
The following shows the default items to be selected.
Example) To display 13:25:45
• [13:25]
• [13:25:45]
• [01:25(PM)]
• [01:25:45(PM)]

• 

• 

• 

• 

[Fill with 0] When the time, minute, and/or second are/is in single digit, 0 is displayed before the single-
digit number.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

[13時25分]
[13時25分45秒]
[午前01時25分]
[午前01時25分45秒]
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3) [Shape Settings]

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Numerical Gothic]
• [TrueType Numerical 7seg]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Text Color]
Set the text color.
➟6.4 Color Settings

Item Description

[Shape]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.4 Color Settings
When the characters to be displayed overlap with the shape frame area, the characters 
cannot be displayed normally.
Set the characters to be displayed and the shape frame area in a way that does not make 
them overlap each other.

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

Preview Displays the preview of the screen.

Item Description

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3
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■2 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Layer]

Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

3) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■4 [Script] tab

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Text/Style]

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Text Color] text_color ○ ○ When the object is updated

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.6.5 Relevant settings

Set the relevant settings other than the specific settings for the data display and time display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT Designer3
Always enabled.

[Adjust object display order in GOT to the one in GT 
Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
8. OBJECT FUNCTION
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8.7 Placing a Comment Display

■1 Comment display (bit)
This function displays the comment corresponding to the on/off status of a bit device.

■2 Comment display (word)
This function displays the comment corresponding to the value of a word device.

■3 Comment display (simple)
This function displays comments without setting a device.

8.7.1 Specifications of the comment display

■1 Maximum number of objects arrangeable on one screen
Up to 1024 comment displays can be placed on each screen.

■2 Comment to be used
The comment display uses the comment that is created in the comment group.

➟5.8 Comment Setting ([Comment])

■3 Superimposing a comment display on a level object
A comment display can be superimposed on a level object.
For restrictions on superimposing a comment display on a level object, refer to the following. 

➟8.23 Placing a Level Object

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

X10 = OFF X10 = ON

Comment of when the bit 
device is off

Comment of when the bit 
device is on

Production line status Production line status

Conveyor stopped Operating

The comment No. 10 
is displayed.

The comment No. 100 
is displayed.

Production line status

Conveyor stopped

The comment No. 1 
is displayed.

Production line status

Completed

Production line status

Operating

100D100D100 101D100

The comment No. 1 is 
always displayed.

Production line status

Operating

Comment No. 1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.7.2 How to use the comment display

■1 Placing the comment display
Place comment displays on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing comment displays
Edit comment displays that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting comment displays
Set comment displays that have been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
Comment display (bit) settings

➟8.7.4 [Bit Comment Display] dialog
Comment display (word) settings

➟8.7.5 [Word Comment Display] dialog
Comment display (simple) settings

➟8.7.6 [Simple Comment Display] dialog

■4 How to adjust the display position of shapes set for objects
Select [Edit] → [Edit Touch Area] → [Manual Edit] from the menu to adjust the display position of touch areas and shapes.

➟6.6.14 [Edit Touch Area]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10

Touch area
Figure
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■5 Displaying the comment that exceeds the display range
The display method for the comment that exceeds the display range can be set.
Select the comment display on the screen editor to display the numbers of digits and rows that are available for the object 
size in the status bar.
If the stroke font is used, the available numbers of digits and rows are not displayed in the status bar.

(1) Displaying the comment with the word wrap
If a comment exceeds the display range horizontally, the comment is wrapped to the next line.
However, the word wrap is not applicable to the comment displayed in a Windows font.

If a comment exceeds the display range vertically, only the part of the comment within the range is displayed.

(2) Displaying the comment without the word wrap
When [Adjust Text Size] is selected, the comment is resized automatically so that the entire comment fits on the display 
range.

➟8.7.4 ■2 [Comment] tab
　 8.7.5 ■2 [Comment] tab
8.7.6 [Simple Comment Display] dialog

8.7.3 Precautions for a comment display object

■1 Object size
Some comment cannot be displayed within the display range by language switching.
Set the display range of the object after considering the number of characters in the registered comment.
The display range of the comment can be checked on the screen of GT Designer3 by changing the preview column No.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

■2 Setting the comment group
If the nonexistent value (column No.) is stored in the language switching device, the comment is not displayed.

Comment display

Check the frame.

Comment
Check the frame.

Comment display

Check the frame.
OK: Restart after pushing OK switch

Comment
Check the frame.
OK: Restart after pushing OK switch
NG: Restart after pushing NG switch

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.7.4 [Bit Comment Display] dialog

Step 1 Select [Object] → [Comment Display] → [Bit Comment] from the menu.
Step 2 Click the position where you place the comment display (bit). Placing the comment display (bit) is completed.
Step 3 Double-click the comment display (bit) which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Comment] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Script] tab

■1 [Device/Style] tab

1) [Comment Display Type]
Select the comment display type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) Preview list

Displays the shapes for the on and off status.
4) [Shape]

Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 ■1 Setting object shapes

When the characters to be displayed overlap with the shape frame area, the characters cannot be displayed 
normally.
Set the characters to be displayed and the shape frame area in a way that does not make them overlap each other.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

7)

2)

3)

4)

5)

6)
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5) [Shape Color]
Select the color of the shape.

6) [Frame Color]
Select the frame color of the shape.

➟6.4 Color Settings
7) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Comment] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [OFF=ON]
Selecting this item applies the same setting to both when the switch is on and off.

2) Preview list
Displays the shapes for the on and off status.

3) [Copy Range]
Set the range to be copied.
The following shows the items to be selected.

• [All settings]: Copies all the text settings.
• [Text only]: Copies the text only.

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

ABCDE ABCDE

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
4)

5) Text

8)

7)

6)
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4) [OFF→ON], [ON→OFF]
Copies the text setting.
Depending on the selection in the preview list, the copy source and copy destination are different.

• [OFF→ON]: Copies the setting for when the switch is off to the setting for when the switch is on by clicking the 
[Copy] button.

• [ON→OFF]: Copies the setting for when the switch is on to the setting for when the switch is off by clicking the 
[Copy] button.

5) [Comment Group]

6) [Comment]
Depending on the selection in [Display Type], the setting items are different.

Item Description

[Group No.]

Select the setting method of the comment group No.
The following shows the items to be selected.
• [Fixed]:

Enter the comment group No. directly.
The setting range is [1] to [500].

• [Device]:
Set the device which has the same value as the comment group No.

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size]
This item can be set only when [Adjust Text Size] is set.
Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dots.

Item Description

[Display Type]

Select the setting method of the comment.
The following shows the items to be selected.
• [Comment No.]: Set the comment No.
• [Text]: Enter the text directly.

[Comment No.]

Set the comment No. to be display.
The setting range is [0] to [32767].
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

Text

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Change Attribute of Comment Setting] Set the comment attribute such as [Text Color] and [Blink].
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7) [Common Settings of State]

[Use High Quality Font]

Select this item to use the HQ font.
This item can be set only when the following items are set in [Font].
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

[Blink]

Select the blinking speed of the text and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Reverse] Inverts the text.

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Text only]
• [Text and Shape]
These settings are applied to all the conditions to be set.

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

Item Description

[Bold] button

[Solid] button

[Raised] button
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8) [Preview]
Set the comment to be previewed in the preview list.

■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

2) [Use offset]
Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128].

Item Description

[Group No.]
Set the comment group No. to be previewed.
This item can be set only when [Device] is set in [Group No.].
The setting range is [1] to [500].

[Column No.] Set the column No. to be previewed.
The setting range is [1] to [30].

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

6)
7) 8)

5)
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3) [Display Mode]
Display mode when the comment display is superimposed on a level object.

• [Transparent]: Displays the comment on the level object.

• [XOR]: The comment in a comment display is integrated into the XOR synthesis with a level color, to be able 
to be distinguished from the level object.

As the setting is fixed to [Transparent], no additional setting is required accordingly.

The following shows the items to be selected.
• [Transparent]
• [XOR]

4) [Comment Display Start Row]
When setting a comment having multiple rows, set the first row to be displayed.
If the value out of the number of created comment rows is set, the comment is displayed as blank.
If the comment is displayed as blank, check the number of rows of the specified comments.

5) [Number of Comment Display Rows]
When setting a comment having multiple rows, set the number of rows to be displayed.

Item Description

[Fixed] Enter the start row directly.
The setting range is [1] to [32767].

[Device]

Set the device value as the start row to be displayed.
➟6.1.2 How to set devices
Example) When [Device] is selected and [D10] is set

Item Description

[Fixed] Enter the number of rows to be displayed directly .
The setting range is [1] to [32767].

[Device]

Set the device value as the number of rows to be displayed.
➟6.1.2 How to set devices
If the device value is zero, the comment is not displayed.
Example) When [Device] is selected and [D20] is set

FULL

20% 40%40%

GOT Graphic Ver.2

GOT Graphic Ver.1

Comment registered in GT Designer3
Row 1
Row 2
Row 3
Row 4
Row 5
Row 6

View in the GOT

Inspection 1
Conveyor inspection

Change the device value 1 to 3.

The comment is displayed from the first row.

The comment is displayed from the third row.

Inspection 1
Conveyor inspection
Inspection 2
Workpiece inspection
Inspection 3
Line inspection

Inspection 2
Workpiece inspection

Device: D10 1

Device: D10 3

Comment registered in GT Designer3
Row 1
Row 2
Row 3
Row 4
Row 5
Row 6

View in the GOT

Inspection 1
Conveyor inspection Two rows of the comment are displayed.

Four rows of the comment are displayed.

Inspection 1
Conveyor inspection
Inspection 2
Workpiece inspection
Inspection 3
Line inspection

Inspection 2
Workpiece inspection

Device: D20 2

Device: D20 4Inspection 1
Conveyor inspection

Change the device value from 2 to 4.
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6) [KANJI region]
Select the KANJI region of the displayed text.

➟1.2.5 Font specifications
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

7) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

8) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

■5 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device/Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended]

[Text Color] text_color ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Alignment] arrange ○ ○ When the object is updated

[Extended]
[Security Level] security ○ ○ When the object is updated When the screen is updated

[Display Mode] draw_mode ○ ○ When the object is updated
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8.7.5 [Word Comment Display] dialog

Step 1 Select [Object] → [Comment Display] → [Word Comment] from the menu.
Step 2 Click the position where you place the comment display (word). Placing the comment display (word) is 

completed.
Step 3 Double-click the comment display (word) which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Comment] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Device/Style] tab

For the conditions, refer to the following.
➟6.5.5 ■2 Setting conditions

1) [Comment Display Type]
Select the comment display type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN8]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

5)

10)

15)

6) 7) 8) 9)

4)

11)

3)

12)
13)

14)
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• [Unsigned BIN8]
• [BCD16]

4) Preview list
Displays set conditions.

5) [Range] button
Displays the preview list in range.

6) [Text] button
Displays the preview list in text.

7) Add button
Adds a new condition.

8) Delete button
Deletes the selected condition.

9) Up button, down button
Changes the order of priority of the selected condition.

10) [Utilize] button
Creates a new condition utilizing the selected condition.

11) [Shape]
Select the shape to be set for the object from the list or with the [Shape] button.

➟6.5.5 ■1 Setting object shapes
When the characters to be displayed overlap with the shape frame area, the characters cannot be displayed 
normally.
Set the characters to be displayed and the shape frame area in a way that does not make them overlap each other.

12) [Shape Color]
Select the color of the shape.

➟6.4 Color Settings
13) [Frame Color]

Select the frame color of the shape.
➟6.4 Color Settings

14) [Range]
Set a condition which changes the display property of the lamp.
Click the [Exp] button, and set the conditional expression in the [Edit Range] dialog.
For the details of the [Edit Range] dialog, refer to the following.

➟6.5.5 ■2 (3) [Edit Range] dialog
15) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Frame shape area
Characters which overlap with the 
frame shape area are not displayed.

View in the GOTView in GT Designer3

ABCDE ABCDE
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■2 [Comment] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) Preview list
Displays set conditions.

2) [Range] button
Displays the preview list in range.

3) [Text] button
Displays the preview list in text.

4) Add button
Adds a new condition.

5) Delete button
Deletes the selected condition.

6) Up button, down button
Changes the order of priority of the selected condition.

7) [Utilize] button
Creates a new condition utilizing the selected condition.

8) [Comment Group]

Item Description

[Group No.]

Select the setting method of the comment group No.
The following shows the items to be selected.
• [Fixed]:

Enter the comment group No. directly.
The setting range is [1] to [500].

• [Device]:
Set the device which has the same value as the comment group No.

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

3) 4) 5) 6)

1)

7)

8)

9)

10)

11)
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9) [Comment]
Depending on the selection in [Display Type], the setting items are different.

[Minimum Size]
This item can be set only when [Adjust Text Size] is set.
Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dots.

Item Description

[Display Type]

Select the setting method of the comment.
The following shows the items to be selected.
• [Comment No.]: Set the comment No.
• [Indirect Device]: Set the comment No. of the monitor device value.
• [Hold]: Select this item to hold the comment being displayed on the current screen.

[Comment No.]

Set the comment No. to be display.
The setting range is [0] to [32767].
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

[Change Attribute of Comment Setting] Set the comment attribute such as [Text Color] and [Blink].

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Bold] button

[Solid] button

[Raised] button
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10) [Common Settings of State]

11) [Preview]
Set the comment to be previewed in the preview list.

[Blink]

Select the blinking speed of the text and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Reverse] Inverts the text.

[Blink Scope]

Select the area to be blinked.
The following shows the items to be selected.
• [Text only]
• [Text and Shape]
These settings are applied to all the conditions to be set.

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128].

Item Description

[Group No.]
Set the comment group No. to be previewed.
This item can be set only when [Device] is set in [Group No.].
The setting range is [1] to [500].

[Column No.] Set the column No. to be previewed.
The setting range is [1] to [30].

Item Description
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

2) [Use offset]

[Comment No.]

Set the comment No. to be previewed.
The setting range is [0] to [32767].
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.
• Number of characters:

The line feed is counted as two characters.
• Number of digits:

The number of digits of the row with the largest number of digits is displayed.
• Number of rows:

The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

6)

5)

7)
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Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Display Mode]

Display mode when the comment display is superimposed on a level object.
• [Transparent]: Displays the comment on the level object.

• [XOR]: The comment in a comment display is integrated into the XOR synthesis with a level color, to be able 
to be distinguished from the level object.

As the setting is fixed to [Transparent], no additional setting is required accordingly.

The following shows the items to be selected.
• [Transparent]
• [XOR]

4) [Comment Display Start Row]
When setting a comment having multiple rows, set the first row to be displayed.
If the value out of the number of created comment rows is set, the comment is displayed as blank.
If the comment is displayed as blank, check the number of rows of the specified comments.

5) [Number of Comment Display Rows]
When setting a comment having multiple rows, set the number of rows to be displayed.

Item Description

[Fixed] Enter the start row directly.
The setting range is [1] to [32767].

[Device]

Set the device value as the start row to be displayed.
➟6.1.2 How to set devices
Example) When [Device] is selected and [D10] is set

Item Description

[Fixed] Enter the number of rows to be displayed directly .
The setting range is [1] to [32767].

[Device]

Set the device value as the number of rows to be displayed.
➟6.1.2 How to set devices
If the device value is zero, the comment is not displayed.
Example) When [Device] is selected and [D20] is set

FULL

20% 40%40%

GOT Graphic Ver.2

GOT Graphic Ver.1

Comment registered in GT Designer3
Row 1
Row 2
Row 3
Row 4
Row 5
Row 6

View in the GOT

Inspection 1
Conveyor inspection

Change the device value from 1 to 3.

The comment is displayed from the first row.

The comment is displayed from the third row.

Inspection 1
Conveyor inspection
Inspection 2
Workpiece inspection
Inspection 3
Line inspection

Inspection 2
Workpiece inspection

Device: D10 1

Device: D10 3

Comment registered in GT Designer3
Row 1
Row 2
Row 3
Row 4
Row 5
Row 6

View in the GOT

Inspection 1
Conveyor inspection Two rows of the comment are displayed.

Four rows of the comment are displayed.

Inspection 1
Conveyor inspection
Inspection 2
Workpiece inspection
Inspection 3
Line inspection

Inspection 2
Workpiece inspection

Device: D20 2

Device: D20 4Inspection 1
Conveyor inspection

Change the device value from 2 to 4.
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6) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

7) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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For details, refer to the following.
➟6.2.1 ■2 Correspondence between functions and trigger types

For details of each item, refer to the following.
➟6.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Depending on the selection for [Operation Type], the setting items are different.

(1) [Data Operation]

This item can be set only when [Operation Type] is [Data Operation].
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]
• [Right]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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3) [Data Operation]
Select the format of the expression operating with the data operation.
The following shows the items to be selected.

• [None]
• [Data Expression]

(2) [Script]

This item can be set only when [Operation Type] is [Script].
For the settings of scripts, refer to the following.

➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

[Device/Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended]

[Text Color] text_color ○ ○ When the object is updated

[Blink] blink ○ ○ Upon the setting change When the object is updated

[Blink Scope] blink ○ ○ Upon the setting change When the object is updated

[Reverse] highlight ○ ○ When the object is updated

[Text Size] (width) text_width ○ ○ When the object is updated

[Text Size] (height) text_height ○ ○ When the object is updated

[Alignment] arrange ○ ○ When the object is updated

[Extended]
[Security Level] security ○ ○ When the object is updated When the screen is 

updateddd

[Display Mode] draw_mode ○ ○ When the object is updated

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)
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8.7.6 [Simple Comment Display] dialog

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Step 1 Select [Object] → [Comment Display] → [Simple Comment] from the menu.
Step 2 Click the position where you place the comment display (simple). Placing the comment display (simple) is 

completed.
Step 3 Double-click the comment display (simple) which has been placed to display the setting dialog.

1) [Comment Group No.]
Set the comment group number to be used.
The setting range is [1] to [500].
When the nonexistent comment group No. is set, the comment is not displayed.

2) [Preview Column No.]
Set the column No. to be displayed.
The setting range is [1] to [30].

3) [Comment No.]
Set the comment No. to be display.
The setting range is [0] to [32767].
If [0] is set, the comment is not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)

4)

5)

7)

9)

6)

2)

8)
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4) [Size/Alignment]

5) [Change Attribute of Comment Setting]
Set the comment attribute such as [Text Color] and [Blink].

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Alignment] Set the vertical or horizontal position of the text.

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size]
This item can be set only when [Adjust Text Size] is set.
Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dots.

Item Description

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

[Blink]

Select the blinking speed of the text and shape.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

[Reverse] Inverts the text.

[Bold] button

[Solid] button

[Raised] button
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6) [Control displaying/hiding]
Set the device that controls display/hide of all objects.

➟6.1.2 How to set devices
7) [Layer]

Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

8) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
9) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

8.7.7 Relevant settings

Set the relevant settings other than the specific settings for the comment display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT Designer3
Always enabled.

[Adjust object display order in GOT to the one in GT 
Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.8 Placing a Parts Display

With this function, registered parts, base screens, and window screens can be displayed corresponding to the status of 
a device.

■1 How to switch the parts
(1) Parts display (bit)

➟8.8.4 [Bit Parts Display] dialog
This object displays a part, base screen, or window screen corresponding to the ON or OFF status of a bit device.

(2) Parts display (word)
➟8.8.5 [Word Parts Display] dialog

This object displays a part, base screen, or window screen corresponding to the value of a word device.

(3) Parts display (fixed)
➟8.8.6 [Fixed Parts Display] dialog

This function displays the parts, base screen, and window screen corresponding to the rising edge or falling edge of a bit 
device.
Only one type of parts can be displayed. However, the parts can be displayed with another parts display superimposed 
on it.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

X10 = OFF X10 = ON

Displays the part 
corresponding to the on 
status of the bit device.

Displays the part 
corresponding to the off 
status of the bit device.

D100 = 1 D100 = 10 D100 = 100

Part of part No. 1
is displayed.

Part of part No. 10
is displayed.

Part of part No. 100
is displayed.

X1
ON

Parts of parts display A Parts of parts display B

Parts display B is 
displayed 
when X1 is on. Displays parts display B with 

parts display A superimposed on it.

Display condition of 
parts display B: 
When X1 is on
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8.8.1 Specifications of the parts display

■1 Maximum number of objects arrangeable on one screen
Up to 1024 parts displays can be placed on each screen.

■2 Parts displayed by parts displays
The following two types of parts can be displayed by the parts display, and the parts need to be registered in advance.

(1) The parts data registered as the parts in GT Designer3 (registered parts)
➟5.9 Registering Parts ([Parts])

(2) BMP file, JPEG file, and PNG file (BMP file parts, JPEG file parts, PNG file parts) which are stored in 
the data storage

➟5.9.3 ■6 Using the image file stored in the data storage as a part

■3 Types of parts which can be displayed

■4 Setting the parts to be integrated into an XOR synthesis

(1) BMP file parts, JPEG file parts, PNG file parts registered in GT Designer3
XOR synthesis is not available for PNG file parts.
To integrate BMP file parts or JPEG file parts by XOR synthesis, set such parts on the back layer. (Not available in GT21 
and GS21)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Type Description Remarks

Parts

Displays the figure registered as a part.
Example) Registrable figures as parts

• The parts are required to be 
registered in advance.

➟5.9 Registering Parts ([Parts])

　 5.9.3 ■6 Using the image file 
stored in the data storage as a 
part

Mark

Switches the figure colors which are registered as the parts corresponding to the change 
of device status.
Because one part can display different images, the registration of multiple parts is not 
necessary and the capacity of the GOT memory can be saved.

• The parts with BMP format, JPEG 
format, or PNG format cannot be 
used.

• Draw the part whose color is to be 
switched in white.

• While fixed parts are being 
displayed, switching to multiple 
colors cannot be executed. The 
display is only in a single color.

Base screen Displays the figure on a base screen and window screen.

• The object set on a base screen or 
window screen is not displayed.Window screen

Figure Text BMP file, 
JPEG file, 
PNG file

White

The display color of the white space can be changed.

D100 = 0 D100 = 50 D100 = 100

Blue Red

 {

Screen display
Base screen 1

The figure of base screen 20 
is displayed on base screen 1.

+
Line A control

Base screen 20

Line A control

GOT Graphic Ver.1
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(2) When superimposing multiple parts displays and integrating them into an XOR synthesis
• Among parts displays, only parts displays (fixed parts) can be superimposed.
• Place all the parts display objects targeted for an XOR synthesis on the same layer. (Not available to GT21 and 

GS21)
• If they are placed on the front layer, the portion on which no parts are superimposed is combined with [Front Layer 

Transparent Color] of the screen by XOR synthesis. (Not available to GT21 and GS21)

(3) When integrating parts including characters into an XOR synthesis
In cases where the parts to be displayed includes an object whose character effect is set to [Bold], [Solid], or [Raised], 
the characters may be chipped or the character color may not be displayed normally when the parts are displayed.

(4) Combining a user-registered logo text part with other parts or objects by XOR synthesis
To combine a user-registered logo text part with other parts or objects by XOR synthesis, select [Background Color] in 
the [Logo Text] dialog.
If [Background Color] is deselected, the logo text part cannot be combined with other parts or objects by XOR synthesis.

8.8.2 How to use the parts display

■1 Placing the parts display
Place parts displays on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing parts displays
Edit parts displays that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting parts displays
Set parts displays that have been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
Parts display (bit) settings

➟8.8.4 [Bit Parts Display] dialog
Parts display (word) settings

➟8.8.5 [Word Parts Display] dialog
Parts display (fixed) settings

➟8.8.6 [Fixed Parts Display] dialog

■4 Method of displaying BMP file parts, JPEG file parts, and PNG file parts in the data storage
BMP file parts, the JPEG file parts, and the PNG file parts can be displayed by object or project.

(1) Method of displaying by object (in the use of image files)
(a) When using BMP file parts, JPEG file parts, and PNG file parts in the data storage

Specify a BMP file, JPEG file, or PNG file stored in the data storage at each object setting of the parts display to display 
as parts.

Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.
For the storing method, refer to the following.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 When the display condition set for a parts display to display parts is satisfied, the specified BMP file part, 

JPEG file part, or PNG file part in the data storage is displayed.
Set the following items in the [Device/Style] tab of the parts display and use the parts display.

• Setting image files
• Setting image file numbers

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Display example
The following shows a display example of when a BMP file part is stored in the data storage.

Example) Displaying BMP images in the parts display (word)
Set image files and write parts numbers between 1 and 65536 in a word device to display the BMP images.

• Word device to display the parts: D100

(2) Method of displaying by project
To display BMP file parts, JPEG file parts, or PNG file parts in the data storage, specify the parts No. from 9001 to 9999.
To display the BMP file parts, the JPEG file parts, or the PNG file parts in the data storage when the parts No. from 9001 
to 9999 is specified, follow the following procedure.

(a) When using BMP file parts, JPEG file parts, and PNG file parts in the data storage
This method is applied to display BMP files, JPEG files, or PNG files in the data storage when the parts number 9001 to 
9999 is specified.

Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 Select [Show image files in the memory card when Parts No. 9001-9999 is specified] in the [Parts Setting] 

dialog and write the setting to the GOT.

Step 3 When the display condition (parts number: 9001 to 9999) set for a parts display to display parts is satisfied, 
the BMP file part, JPEG file part, or PNG file part in the data storage is displayed.
The settings of [Image File Setting] and [Image File No.] are unnecessary.

IMG0001.BMP IMG0500.BMP
IMG0999.BMP

D100 D100 D100 D1000 1 500 999

When specifying 0 for 
the parts No., the BMP 
file parts are hidden.

The BMP file parts 
(IMG0001.BMP) is displayed.

The BMP file parts 
(IMG0500.BMP) is displayed.

The BMP file parts 
(IMG0999.BMP) is displayed.
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(b) When displaying BMP file parts, JPEG file parts, and PNG file parts in the data storage using 
GS450.b8
Not available to GT21 and GS21.
This method is applied to switch between the parts registered in GT Designer3 and BMP files, JPEG files, or PNG files 
in the data storage when the parts number 9001 to 9999 is specified.
To use GS450.b8, deselect [Show image files in the memory card when Parts No. 9001-9999 is specified] in the [Parts 
Setting] dialog.
If the above setting is valid, BMP files, JPEG files, or PNG files in the data storage can be used as parts regardless of 
the status of GS450.b8.

Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 Turn on GS450.b8.
Step 3 When the display condition (parts number: 9001 to 9999) set for a parts display to display parts is satisfied, 

the BMP file part, JPEG file part, or PNG file part in the data storage is displayed.

(c) Display example
The following shows a display example of when a BMP file part is stored in the data storage.

Example) Displaying BMP file parts in a parts display (word part)
Write the parts numbers between 9001 and 9999 to a word device to display the BMP file parts.

• Word device to display the parts: D100

(1) When specifying a parts number other than 9001 to 9999
Even if BMP file parts, JPEG file parts, or PNG file parts in the data storage are set to be displayed, parts 
registered in GT Designer3 are displayed when a parts number out of the range between 9001 and 9999 is 
specified.

(2) When switching to BMP file parts, JPEG file parts, or PNG file parts in the data storage that 
are given the same parts number (only when using GS450.b8)
Not available to GT21 and GS21.
To switch to a part (BMP file part, JPEG file part, or PNG file part) in the data storage that has been given 
the same parts number while a part registered in GT Designer3 whose parts number is one of 9001 to 9999 
is displayed, follow the following procedure.
Step 1. Turn on GS450.b8.
Step 2. Specify either the parts number 0 or 9000 and hide the displayed part.
Step 3. Specify the parts number of BMP file parts, JPEG file parts, or PNG file parts in the data storage to 
be displayed.

(3) Example of cases where GS450.b8 is automatically turned on after the GOT is powered on

Parts No. GS450.b8: ON GS450.b8: OFF

9001 to 9999 Displays BMP file parts, JPEG file parts, and PNG file parts 
in the data storage. Displays the parts registered in GT Designer3

IMG0001.BMP IMG0500.BMP
IMG0999.BMP

D100     9000 D100     9001 D100     9500 D100     9999

When specifying 0 or 9000 
for the parts No., the BMP 
file parts are hidden.

The BMP file parts 
(IMG0001.BMP) is displayed.

The BMP file parts 
(IMG0500.BMP) is displayed.

The BMP file parts 
(IMG0999.BMP) is displayed.
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Not available to GT21 and GS21.
The following shows an example of cases where GS450.b8 is automatically turned on after the GOT is 
powered on.
This method is useful when using GS450.b8 and displaying BMP file parts, JPEG file parts, and PNG file 
parts in the data storage from the beginning of operation.
Step 1. As a trigger action, make the GOT internal device (device always on: GS0.b4) as a trigger condition 
and make settings that store 1 to GS450.b8 while the trigger is on.
Step 2. Store 1 in GS450.b8 with the trigger action after the GOT is powered on.

• Set in the [Project] tab of [Trigger Action].
• Set this trigger action in the first row of the list.

This stores 1 in GS450.b8 immediately after the GOT is powered on.
Parts of parts displays or parts movements at a GOT startup may not be switched to BMP file 
parts, JPEG file part, or PNG file parts.
(When the screen is switched, the parts are switched.)
Design screens under consideration for the above description.

• Select [Ordinary] for [Trigger Type].

■5 Switching the image on a parts display object automatically
Available to GT27, GT25, GT SoftGOT2000, and GS25.
When an image file stored in drive V is updated, the image on the parts display object is automatically switched.
The image file can be displayed like a video playback when the file is frequently updated.
Write the image files in drive V using the FTP server function.

(1) Displayable image files
The image files that satisfy all the following conditions can be displayed as parts.

• Storage designation: Drive V
• File name: IMG1, IMG2, IMG3, or IMG4
• File format: JPEG
• Resolution: QVGA, VGA, SVGA, or XGA

Camera
(FTP client)

Ethernet

Writing data to drive V of the GOT using the FTP server function

GOT
(FTP server)

Capturing the image of 
a subject with a camera

Displaying an image file stored in drive V 
on a parts display object
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(2) Specifications of drive V
Up to four files can be stored.
Up to 6 MB of data can be stored regardless of the storable number of files.
The status of drive V is not notified and the files stored in drive V are not manipulated.
The image files stored in drive V are deleted at the following timings.

• GT27, GT25, GS25
When the GOT is restarted
Note that the image files are retained if the package data is updated at the restart.

• GT SoftGOT2000
The files are deleted when monitoring starts with GT SoftGOT2000 or GT SoftGOT2000 exits.

(3) Settings of a parts display object
The following shows the settings and operating procedure required for a parts display.

Step 1 Select [Common] → [Parts] → [Parts Setting] from the menu to display the [Parts Setting] dialog.
Step 2 Select [Enable the automatic update of image files].

➟5.9.6 [Parts Setting] dialog
Step 3 Place a parts display object.
Step 4 In the [Device/Style] or [Style] tab, configure the following settings.

• Select [Image File (automatic update)] for [Parts Type].
• Set the image file number to be used in [Detail Settings of Parts].
➟8.8.4 ■1 [Device/Style] tab
8.8.5 ■1 [Device/Style] tab
8.8.6 ■1 [Style] tab

(4) Configuring the FTP server and FTP client settings
Whose FPT server function to be used depends on the GOT model.

• GT27, GT25, GS25
Use the FTP server function of the GOT for settings.

➟10.16 Transferring a File between the GOT and Peripheral Device (FTP Server Function)
• GT SoftGOT2000

Use the FTP server function of Windows for settings.
For the image files stored in drive V, configure the settings on the FTP client to be used.
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■6 Parts No.
Depending on the parts number, the parts that can be displayed and operations are different.
The following shows the relation between the parts numbers and the parts which can be displayed.

○: Can be displayed ×: Cannot be displayed -: Display is deleted

*1 When [Indirect Device] is set for [Detail Settings of Parts] in the [Word Parts Display] dialog, the parts are not hidden.
(The current display is held.)
For the method of hiding parts in the [Word Parts Display] dialog, refer to [Detail Settings of Parts] in the [Word Parts 
Display] dialog.

➟8.9.5 ■1 [Device/Style] tab
*2 Even if the parts registered in GT Designer3 are registered, they cannot be displayed.

Example) When a part registered in GT Designer3 is registered with the parts No. 9123

■7 Setting the image data of parts to a transparent color
When a transparent color is set for the image data of set parts, the setting of the transparent color is enabled.
The following shows the method of enabling a transparent color setting for parts.

• Set a transparent color for the image data.
(Transparent colors can be set only for the image data of BMP files.)

• Register the image data for which the transparent color has been set as parts or into the library.
• Set the registered parts or library as the parts.

➟6.5 Placing and Editing Figures and Objects

Parts No.

When BMP file parts, the JPEG file parts, and PNG file parts 
in the data storage are set to be displayed

When BMP file parts, the JPEG file parts, and PNG file parts 
in the data storage are not set to be displayed

Parts registered in GT 
Designer3

BMP file parts, JPEG file 
parts, and PNG file parts in 

the data storage

Parts registered in GT 
Designer3

BMP file parts, JPEG file 
parts, and PNG file parts in 

the data storage

0 -*1 -*1 -*1 ×

1 to 8999 ○ × ○ ×

9000 × -*1 ○ ×

9001 to 9999 ×*2 ○ ○ ×

10000 to 32767 ○ × ○ ×

When BMP file parts, the JPEG file parts, 
and PNG file parts in the data storage 
are not set to be displayed.

The parts registered in GT Designer3 
(parts No. 9123) are displayed.

BMP file parts, JPEG file parts, 
and PNG file parts are displayed.

When BMP file parts, the JPEG file parts, 
and PNG file parts in the data storage 
are set to be displayed.
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8.8.3 Precautions for a parts display object

■1 Precautions for drawing
(1) Display when a part extends off the screen

If a part is placed so that it extends off the screen, the display on the GOT differs depending on the components of the 
part and [Graphics Setting].

(2) When a part overlaps with another object
Set the parts display in a way that does not make the part overlap with another object.
Otherwise, the overlapped object may not be displayed normally.
In such a case, set the parts display and the object in different layers.
This also applies to cases where an object overlaps with the display area as shown below.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Part components [Graphics Setting] Part display

Image data + figures The part within the screen is displayed.

The part within the screen is displayed.
If a part extends above or left of the screen, the display differs depending on the model used as shown 
below.
• Other than GT SoftGOT2000
The figures within the screen are displayed, whereas image data even within the screen is not 
displayed.
• GT SoftGOT2000 or GT Simulator3
If the image file format is BMP or JPEG, image data within the screen is also displayed.

Image data only The part within the screen is displayed.

The part within the screen is displayed.
When an image file in the data storage is used as a part and the part extends above or left of the 
screen, system alarm 537 is output in the following cases. 
The data will not be displayed.
• Other than GT SoftGOT2000: A BMP file part, JPEG file part, or PNG file part is to be displayed.
• GT SoftGOT2000 or GT Simulator3: A PNG file part is to be displayed.

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.2

GOT Graphic Ver.1

Display area

Parts display (displays parts No. 1)

Display area

• When [Parts Type] is [Parts Data] • When [Parts Type] is [Base Screen]

Displayed on 
the parts display.

Displayed on 
the parts display.

Part No. 1: Base screen 10: 

Parts display (displays base screen 10)
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(3) When specifying a screen for the parts type and XOR for the display type

• When the base screen or window screen is specified as the parts type of a parts display (bit part/word part) and XOR 
is specified as the display type, the parts that have been displayed are deleted and then a new screen is displayed.

• The area to be deleted is the same as that of the base/window screen around the drawing point of the parts display 
(screen (center, top left)).

• When an object is included in the base/window screen area to be deleted, the object is also deleted.
To prevent the object from being deleted, change the parts type from the screen to the parts and adjust the position 
in a way that does not make the parts overlap with an object or change the display type to overwrite when leaving 
the screen being specified as the parts type.
Because the parts that were displayed previously are left when an overwrite operation is performed, the same size 
of parts is required.

• In cases where the parts, base screen, and window screen to be displayed include an object whose character effect 
is set to [Bold], [Solid], or [Raised], the characters may be chipped or the character color may not be displayed 
normally when the parts are displayed.

(4) Displaying the parts for which PNG file parts and logo text parts ([Background Color] is deselected) 
are registered

When all the following conditions are satisfied, the parts display is retained on the GOT even when the display conditions 
are unsatisfied.

• [XOR] is selected for [Display Mode].
• [Adjust object display order in GOT to the one in GT Designer3] in the [Type Setting] dialog is deselected.

For the XOR synthesis and object stacking order adjustment settings, refer to the following.
➟8.8.4 [Bit Parts Display] dialog

8.8.5 [Word Parts Display] dialog
8.8.6 [Fixed Parts Display] dialog
5.1.5 ■3 [Option Setting]

■2 Precautions for use
(1) Deleting parts

Use [Mark Data] and [Parts Data] of [Parts Type] to delete parts.
When [Base Screen] or [Window Screen] of [Parts Type] is used, parts are not deleted even if the parts are specified to 
0. (When the screen is redisplayed after being switched to another, the parts are deleted.)

(2) While reading BMP files, JPEG files, and PNG files
While files are read, the monitor screen stops.

(3) When BMP file parts, JPEG file parts, and PNG file parts are displayed halfway
When an error occurs while files are being on display step by step, the images may be displayed halfway.
In this case, display the parts again or check the BMP file, JPEG file, or PNG file.

(4) Displaying BMP file parts, JPEG file parts, and PNG file parts in the data storage
Do not disconnect the data storage from the GOT while displaying BMP file parts, JPEG file parts or PNG file parts in the 
data storage.

(5) When stopping using BMP file parts, JPEG file parts, and PNG file parts in the data storage
Carry out either of the following operations.

• Change [Parts Setting] of GT Designer3 and write the project.
• Turn off the GOT internal device (GS450.b8).

Even if disconnecting the data storage without carrying out the above operations, the BMP file parts, JPEG file parts, or 
PNG file parts may be displayed due to the following reasons.
BMP file parts, JPEG file parts, and PNG file parts displayed on the GOT are stored in the built-in memory of the GOT. 
(Only one of the BMP file parts, JPEG file parts, PNG file parts is retained.)
If the BMP file parts, JPEG file parts, and PNG file parts which have the same parts number are displayed successively, 
the parts registered with GT Designer3 are not displayed because the BMP file parts, JPEG file parts, and PNG file parts 
stored in the built-in memory of the GOT are displayed.

GOT Graphic Ver.1

GOT Graphic Ver.1
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(6) Priority of settings of GT Designer3 and GS450.b8
When [Show image files in the memory card when Parts No. 9001-9999 is specified] in the [Parts Setting] dialog is 
selected, the BMP file parts, JPEG file parts, or PNG file parts in the data storage are displayed regardless of the status 
of GS450.b8.

8.8.4 [Bit Parts Display] dialog

Step 1 Select [Object] → [Parts Display] → [Bit Parts] from the menu.
Step 2 Click the position to place a bit parts display.
Step 3 Double-click the bit parts display to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Device/Style] tab

1) [Parts Switching]
Select the parts display type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Parts Switching Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) Preview list

Displays the shapes for the on and off status.
4) [Parts Type]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

8)

2)

3)

4)

5)

6)

7)
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Select the type of the parts for the parts display.

5) [Display Mode]
Select a method of displaying at parts switching.

• [Replace]
Deletes the parts displayed previously and displays the new parts.
When [Parts Type] is [Base Screen] or [Window Screen], this item cannot be set.

• [XOR]
After deleting the parts displayed previously, the areas which overlap with the new part are displayed with an 
XOR synthesis.
For the combination of overlapped colors with an XOR synthesis, refer to the following

• [Overwrite]
Displays a new part, base screen, or window screen on the part that has been displayed.

Item Description

[Parts]

Displays registered parts.
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Mark Data]

Switches the white area of the registered part to another display color according to the 
change of the device status.
After selecting, set [Parts No.] to be displayed.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.
➟5.9 Registering Parts ([Parts])
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Base Screen] Displays the registered base screens as parts.

[Window Screen] Displays the registered window screens as parts.

[Image File]
Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟(1) [Image File Setting] dialog

[Image File (automatic update)]

Available to GT27, GT25, GT SoftGOT2000, and GS25.
Select an image file in drive V to display it as a part.
When the file in drive V is updated, the image on the parts display object is automatically 
switched.
For the image files that can be used, refer to the following.

➟8.8.2 ■5 Switching the image on a parts display object automatically
Set the image file No. to be used in [Details Settings of Parts].
When [XOR] is selected for [Display Mode], even though an image file in drive V is 
updated, the image on the parts display object is not automatically switched.

Figure

Parts
display

Parts
switching

Parts New part

Figure (blue)

Parts
display

Parts
switching

Super imposed area 
is changed to yellow.

Part No. 1
(white)

Superimposed area 
is changed to white.

Part No. 2
(red)

The colors of the figure + part No. 2 
are integrated into an XOR synthesis.

The colors of the figure + part No. 1 
are integrated into an XOR synthesis.
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As the setting is fixed to [Replace], no additional setting is required accordingly.

The following shows selectable items.
• [Replace]
• [XOR]
• [Overwrite]

6) [Alignment]
Select the default display position of parts, base screens, and window screens.

• [Top-Left]
Sets the top left of parts, base screens, and window screens as the default display position.

• [Center]
Sets the center of parts, base screens, and window screens as the default display position.

7) [Detail Settings of Parts]

8) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.

Item Description

[Parts No.]

Set the number that has been assigned to the part, base screen, or window screen to be 
displayed.
Click the [Parts Data] button to check the registered parts, base screen, and window 
screen.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from white.

[Screen No.] When selecting [Base Screen] or [Window Screen] for [Parts Type], specify the screen No.
Click the [Screen] button to check the registered parts, base screen, and window screen.

[Image File No.]

Set the image file No. when you select [Image File] or [Image File (automatic update)] for 
[Part Type].
The setting range varies with the selection for [Parts Type] or [Digits] in the [Image File 
Setting] dialog.
• Selecting [Image File] for [Parts Type]

When [Digits] is [5]: [0] to [65535]
[Digits] is [4]: [0] to [9999]
[Digits] is [3]: [0] to [999]
[Digits] is [2]: [0] to [99]
[Digits] is [1]: [0] to [9]

• Selecting [Image File (automatic update)] for [Parts Type]
[0] to [4]

When 0 is set for [Screen File No.], images are deleted.
When displaying only images for the on status, set 0 for [Image File No.] for the off status.

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

Figure

Parts
display

Parts
switching

Parts New part

GOT Graphic Ver.2

GOT Graphic Ver.1

Top left Center

Set display position Set display position
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The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(1) [Image File Setting] dialog

Select an image file to be displayed as a part.

1) Image file path
Displays the full path to the specified image file.
Set the path with 78 characters or less in total.
Example) Using IMG00001.bmp stored in Package1 folder in drive X as a part

When [Image File No.] is set to [0], the path is not displayed.
2) [Drive Name]

Select the drive to store the image file.
The following shows the items to be selected.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

3) [Folder Name]
Specify the folder in which image files are stored.

4) [File Name]
Specify the first character string of the image file name.

5) [Digits]
Specify the number of digits for [Image File No.].
The setting range is [1] to [5].

6) [Transparent]
Enable the transparent color setting for the image file selected in this dialog.
This setting is only effective for BMP files.
Set a transparent color in the [Transparent Setting].

➟7.13.1 [Transparent Setting] dialog
Click the [From Image] button to display the [Open] dialog.
Select an image file to be used in the [Transparent Setting] dialog, and the [Transparent Setting] dialog is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
4)
5)
6)

X:\Package1\IMG00001

Maximum file path length: 78

[Drive Name] [Folder Name] [File Name] [Image File No.]
(Set the number of digits for [Digits].)
8. OBJECT FUNCTION
8.8 Placing a Parts Display

8 - 343



■2 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

[Device/Style]

[Display Mode] draw_mode ○ ○ When the object is updated

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.8.5 [Word Parts Display] dialog

Step 1 Select [Object] → [Parts Display] → [Word Parts] from the menu.
Step 2 Click the position to place a word parts display.
Step 3 Double-click the word parts display to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Operation/Script] tab

■1 [Device/Style] tab

1) [Parts Switching]
Select the parts display type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Parts Switching Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

15)

14)

2)

4)

9)

3)

10)

11)

5) 6) 7)

13)

12)

8)
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4) Preview list
Displays set conditions.

5) Add button
Adds a new condition.

6) Delete button
Deletes the selected condition.

7) Up button, down button
Changes the order of priority of the selected condition.

8) [Utilize] button
Creates a new condition utilizing the selected condition.

9) [Parts Type]
Select the type of the parts for the parts display.

10) [Display Mode]
Select a method of displaying at parts switching.

• [Replace]
Deletes the parts displayed previously and displays the new parts.
When [Parts Type] is [Base Screen] or [Window Screen], this item cannot be set.

• [XOR]
After deleting the parts displayed previously, the areas which overlap with the new part are displayed with an 
XOR synthesis.
For the combination of overlapped colors with an XOR synthesis, refer to the following

Item Description

[Parts]

Displays registered parts.
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Mark Data]

Switches the white area of the registered part to another display color according to the 
change of the device status.
After selecting, set [Parts No.] to be displayed.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.
➟5.9 Registering Parts ([Parts])
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Base Screen] Displays the registered base screens as parts.

[Window Screen] Displays the registered window screens as parts.

[Image File]
Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟8.8.4 ■1 (1) [Image File Setting] dialog

[Image File (automatic update)]

Available to GT27, GT25, GT SoftGOT2000, and GS25.
Select an image file in drive V to display it as a part.
When the file in drive V is updated, the image on the parts display object is automatically 
switched.
For the image files that can be used, refer to the following.

➟8.8.2 ■5 Switching the image on a parts display object automatically
Set the image file No. to be used in [Details Settings of Parts].
When [XOR] is selected for [Display Mode], even though an image file in drive V is 
updated, the image on the parts display object is not automatically switched.

Figure

Parts
display

Parts
switching

Parts New part
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• [Overwrite]
Displays a new part, base screen, or window screen on the part that has been displayed.

As the setting is fixed to [Replace], no additional setting is required accordingly.

The following shows selectable items.
• [Replace]
• [XOR]
• [Overwrite]

11) [Alignment]
Select the default display position of parts, base screens, and window screens.

• [Top-Left]
Sets the top left of parts, base screens, and window screens as the default display position.

• [Center]
Sets the center of parts, base screens, and window screens as the default display position.

12) [Range]
• [Bit]

Select this item when changing the display according to the on and off status of the bit device.
After selecting, set the bit device and device status (ON, OFF).

• [Word]
Select this item when changing the display according to the value of a word device.
After selecting, set the conditional expression for the value of the word device with [Range] button.

Figure (blue)

Parts
display

Parts
switching

Super imposed area
is changed to yellow.

Part No. 1
(white)

Superimposed area
is changed to white.

Part No. 2
(red)

The colors of the figure + part No. 2
are integrated into an XOR synthesis.

The colors of the figure + part No. 1
are integrated into an XOR synthesis.

Figure

Parts
display

Parts
switching

Parts New part

GOT Graphic Ver.2

GOT Graphic Ver.1

Top left Center

Set display position Set display position
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13) [Detail Settings of Parts]
When an option other than [Indirect Device] is selected, conditions are required to be set.
The following shows how the parts are switched according to the setting of [Detail Settings of Parts] and set 
conditions.

For the details of conditions, refer to the following.
➟6.5.5 ■2 Setting conditions

[Detail Settings of Parts]
Condition setting

Enabled None

Indirect device

Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Depending on the value of the parts 
switching device, parts are switched and 
displayed.

Set a condition as required.
Depending on the monitor device value, parts 
are switched and displayed.
Set a condition when switching parts 
according to the other conditions.

[Parts No.] Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Displays the parts set for [Detail Settings of 
Parts].

Make sure to set a condition.
Otherwise, only one type of parts is displayed 
continuously.
Switching to another part cannot be 
performed.

[Mark Color]

[Hold]

Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Holds the display of the parts set for the 
condition.

Make sure to set a condition.
Without the setting of a condition, nothing is 
displayed.

Item Description

[Indirect Device]

Display the [Parts No.] corresponding to the value of the parts switching device.
When the value of the parts switching device is 0, deleted the part.
When deleting the parts, set $V==0 for [Range].

[Parts No.]

Set the number that has been assigned to the part, base screen, or window screen to be 
displayed.
Click the [Parts Data] button to check the registered parts, base screen, and window 
screen.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from white.

[Screen No.] When selecting [Base Screen] or [Window Screen] for [Parts Type], specify the screen No.
Click the [Screen] button to check the registered parts, base screen, and window screen.

[Image File No.]

Set the image file No. when you select [Image File] or [Image File (automatic update)] for 
[Part Type].
The setting range varies with the selection for [Parts Type] or [Digits] in the [Image File 
Setting] dialog.
• Selecting [Image File] for [Parts Type]

When [Digits] is [5]: [0] to [65535]
[Digits] is [4]: [0] to [9999]
[Digits] is [3]: [0] to [999]
[Digits] is [2]: [0] to [99]
[Digits] is [1]: [0] to [9]

• Selecting [Image File (automatic update)] for [Parts Type]
[0] to [4]

When 0 is set for [Screen File No.], images are deleted.
When displaying only images for the on status, set 0 for [Image File No.] for the off status.

The parts of the part 
No. 100 are displayed.

Monitor device value

D200: 100
8 - 350 8. OBJECT FUNCTION
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14) [Preview No.]
Displays the part of the specified parts number on the screen of GT Designer3.
The setting range is [0] to [32767].

15) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15]. If you do not use the security function, select [0].

2) [Use offset]
Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

3) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Operation/Script] tab

Depending on the selection for [Operation Type], the setting items are different.

(1) [Data Operation]

This item can be set only when [Operation Type] is [Data Operation].
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Select the format of the expression operating with the data operation.
The following shows the items to be selected.

• [None]
• [Data Expression]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]
• [Right]

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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(2) [Script]

This item can be set only when [Operation Type] is [Script].
For the settings of scripts, refer to the following.

➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

[Device/Style]

[Display Mode] draw_mode ○ ○ When the object is updated

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.8.6 [Fixed Parts Display] dialog

Step 1 Select [Object] → [Parts Display] → [Fixed Parts] from the menu.
Step 2 Click the position to place a fixed parts display.
Step 3 Double-click the fixed parts display to display the setting dialog.

➟■1 [Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Style] tab

1) [Parts Type]
Select the type of the parts for the parts display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Parts]

Displays registered parts.
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Mark Data]

Switches the white area of the registered part to the color set for [Mark Color].
After selecting, set [Parts No.] to be displayed.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.
➟5.9 Registering Parts ([Parts])
When a transparent color is set for the image data of set parts, the setting of the 
transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.
➟8.8.2 ■7 Setting the image data of parts to a transparent color

[Base Screen] Displays the registered base screens as parts.

[Window Screen] Displays the registered window screens as parts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

5)
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2) [Display Mode]
Select a method of displaying at parts switching.

• [Replace]
Deletes the parts displayed previously and displays the new parts.
When [Parts Type] is [Base Screen] or [Window Screen], this item cannot be set.

• [XOR]
Displays parts, base screens, and window screens with an XOR synthesis on figures or other parts displays.
When the display condition is not satisfied, the parts, base screens, and window screens are deleted.
Example) Display condition: While M100 is on

• [Overwrite]
Displays parts, base screens, and window screens on figures or other parts displays.
Even if the display condition is not satisfied, the display of the parts, base screens, and window screens are 
held.
Example) Display condition: While M100 is on

As the setting is fixed to [Replace], no additional setting is required accordingly.

[Image File]
Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟8.8.4 ■1 (1) [Image File Setting] dialog

[Image File (automatic update)]

Available to GT27, GT25, GT SoftGOT2000, and GS25.
Select an image file in drive V to display it as a part.
When the file in drive V is updated, the image on the parts display object is automatically 
switched.
For the image files that can be used, refer to the following.

➟8.8.2 ■5 Switching the image on a parts display object automatically
Set the image file No. to be used in [Details Settings of Parts].
When [XOR] is selected for [Display Mode], even though an image file in drive V is 
updated, the image on the parts display object is not automatically switched.

Item Description

Figure

Parts
display

Parts
switching

Parts New part

Figure (blue) Super imposed area 
is changed to yellow.

Part No. 1
(white)

The colors of the figure + part No. 1 
are integrated into an XOR synthesis.

The part is deleted.

When a display condition 
is satisfied
(M100: OFF → ON)

When a display condition 
is not satisfied
(M100: ON → OFF)

Figure Parts Display of the
parts is held.

When a display condition 
is satisfied
(M100: OFF → ON)

When a display condition 
is not satisfied
(M100: ON → OFF)

GOT Graphic Ver.2
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The following shows selectable items.
• [XOR]
• [Overwrite]

3) [Alignment]
Select the default display position of parts, base screens, and window screens.

• [Top-Left]
Sets the top left of parts, base screens, and window screens as the default display position.

• [Center]
Sets the center of parts, base screens, and window screens as the default display position.

4) [Detail Settings of Parts]

5) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Parts No.]

Set the number that has been assigned to the part, base screen, or window screen to be 
displayed.
Click the [Parts Data] button to check the registered parts, base screen, and window 
screen.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from white.

[Screen No.] When selecting [Base Screen] or [Window Screen] for [Parts Type], specify the screen No.
Click the [Screen] button to check the registered parts, base screen, and window screen.

[Image File No.]

Set the image file No. when you select [Image File] or [Image File (automatic update)] for 
[Part Type].
The setting range varies with the selection for [Parts Type] or [Digits] in the [Image File 
Setting] dialog.
• Selecting [Image File] for [Parts Type]

When [Digits] is [5]: [0] to [65535]
[Digits] is [4]: [0] to [9999]
[Digits] is [3]: [0] to [999]
[Digits] is [2]: [0] to [99]
[Digits] is [1]: [0] to [9]

• Selecting [Image File (automatic update)] for [Parts Type]
[0] to [4]

When 0 is set for [Screen File No.], images are deleted.

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

GOT Graphic Ver.1

Top left Center

Set display position Set display position
8. OBJECT FUNCTION
8.8 Placing a Parts Display

8 - 357



■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15]. If you do not use the security function, select [0].

2) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

3) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

For details of each item, refer to the following.
➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

[Style]

[Display Mode] draw_mode ○ ○ When the object is updated

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.8.7 Relevant settings

Set the relevant settings other than the specific settings for the parts display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 Parts setting
Select [Common] → [Parts] → [Parts Setting] from the menu to display the [Parts Setting] dialog.

➟5.9.6 [Parts Setting] dialog

■3 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT 
Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

When the display Mode of the parts display is XOR, integrating grouped figures into an 
XOR synthesis simultaneously [Show overlapping areas of shapes in XOR when Display 

Mode of Parts Display is XOR]

Setting whether to use image files in the data storage for parts displays or parts 
movements

[Show image files in the memory card when Parts No. 
9001-9999 is specified]

When [Image File (automatic update)] is selected for [Parts Type], updating the image on 
the parts display object automatically when an image file stored in drive V is updated [Enable the automatic update of image files]

GOT Graphic Ver.1

Function Setting item

Using image files in the data storage as parts for parts displays or parts movements (Read 
device) GS450.b8
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8.8 Placing a Parts Display

8 - 361



8.9 Placing a Parts Movement

This function displays the movement of parts by rearranging their positions based on the word device value.
The parts movement is displayed by the following two types of devices.

• Position device
This device stores the destinations of parts.

➟8.9.2 ■4 How to move the parts (control with the position device)
• Parts switching device

This device switches the types of parts to be displayed.

■1 Switching method of parts (controlled by parts switching devices)
The following shows the methods of switching parts.

(1) Parts movement (bit)
➟8.8.4 ■1 [Device/Style] tab

This object displays two parts by switching between them.

(a) Parts are switched according to the ON or OFF status of a bit device.

(b) A part is displayed or hidden according to the ON or OFF status of a bit device.

(2) Parts movement (word)
➟8.8.5 ■1 [Device/Style] tab

This object displays three or more parts by switching between them.

(a) Parts are switched based on the value of the word device that stores a part number.

(b) The types of parts are switched based on the word device value.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Parts Switching Device]: M10

M10: ON M10: OFF

[Parts Switching Device]: M10

M10: ON M10: OFF

D10 1 D10 2 D10 3 D10 4

[Parts Switching Device]: D10

D10 55 D10 250 D10 4

• [Parts Switching Device]: D10
• [Trigger]

1) 50 <= D10 <= 100

2) 100 < D10

3) Normal 
    (other than the above)

Part No. 1

Part No. 2

Part No. 0 
(not displayed)
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(3) Parts movement (fixed)
➟8.8.6 ■1 [Style] tab

Only one part is displayed.
The setting of [Parts Switching Device] is not required.

8.9.1 Specifications of the parts movement

■1 Maximum number of objects arrangeable on one screen
Up to 1024 parts movement can be placed on each screen.

■2 Parts displayed by the parts movement
The following two types of parts can be displayed by the parts movement, and the parts need to be registered in advance.

(1) The parts data registered as the parts in GT Designer3 (registered parts)
➟5.9 Registering Parts ([Parts])

(2) BMP file, JPEG file, and PNG file (BMP file parts, JPEG file parts, PNG file parts) which are stored in 
the data storage

➟5.9.3 ■6 Using the image file stored in the data storage as a part

■3 Types of parts which can be displayed

[Parts Switching Device]: No settings required

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Type Description Remarks

Parts

Displays the figure registered as a part.
Example) Registrable figures as parts

• The parts are required to be 
registered in advance.

➟5.9 Registering Parts ([Parts])
5.9.3 ■6 Using the image file 
stored in the data storage as a part

Mark

Switches the figure colors which are registered as the parts corresponding to the change 
of device status.
Because one part can display different images, the registration of multiple parts is not 
necessary and the capacity of the GOT memory can be saved. • The parts with BMP format, 

JPEG format, or PNG format 
cannot be used.

• Draw the part whose color is to 
be switched in white.

• While fixed parts are being 
displayed, switching to multiple 
colors cannot be executed. The 
display is only in a single color.

Figure Text BMP file, 
JPEG file, 
PNG file

White

The display color of the white space can be changed.

D100 = 0 D100 = 50 D100 = 100

Blue Red
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8.9.2 How to use the parts movement

■1 Placing the parts movement
Place the parts movement on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing the parts movement
Edit the parts movement that has been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting the parts movement
Set the parts movement that has been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
Setting of the parts movement (bit)

➟8.9.4 [Bit Parts Movement] dialog
Setting of the parts movement (word)

➟8.9.5 [Word Parts Movement] dialog
Setting of the parts movement (fixed)

➟8.9.6 [Fixed Parts Movement] dialog
Setting of the parts movement route

➟8.9.7 [Parts Move Route] dialog

■4 How to move the parts (control with the position device)
The following movement methods are available.

➟(1) Coordinate
(2) Line
(3) Circle
(4) Point specification

The locus display that leaves the locus can be used by setting [Display Mode] in the [Device/Style] or [Style] tab.

Since [Display Mode] is fixed to [Movement], the locus display cannot be used.

Select [Locus] for [Display Mode] to use the locus display.
➟8.9.4 ■1 [Device/Style] tab

8.9.5 ■1 [Device/Style] tab
8.9.6 ■1 [Style] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2

GOT Graphic Ver.1
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(1) Coordinate
Parts are displayed with the coordinates on one-dot basis.
For the coordinates, the values of two word devices are specified as X and Y.
By changing the value of the position device, the display position can be changed on one-dot basis.

(a) Reference coordinate
For the parts which are displayed in an overlap window, the top left of the overlap window is the reference coordinate.
Example) For the overlap window

For other than the above (such as base screens and superimpose windows), the top left of the displayed base screen is 
the reference coordinate.

(2) Line
The part is moved across the set start point and end point.
Set the minimum value to the start point and the maximum value to the end point. The position of the part changes 
according to the position device value and is relative to the start and end points on the line across the two points.

1) (30, 90)

2) (200, 16)

3) (130, 170)

Position device 
(X-axis coordinate): D100
Position device 
(Y-axis coordinate): D101

1) 2) 3)

30

90

200

16

130

170

 
Reference coordinate 
(origin point)

Reference coordinate 
(origin point)

Reference coordinate 
(origin point)

Setting image Movement image

End point (Max.: 100)

Start point (Min.: 0)

Position device: D100

80%

20%D100: 100

D100: 20

D100: 0
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(3) Circle

The displayed part can be moved on the circle around the specified center coordinates.

(a) Center coordinates
Regardless of the coordinates on the screen editor, define the reference coordinates (0, 0) at the position of the parts 
movement object and set the center coordinates relative to the center point.
To specify the center coordinates, note that the positive direction of the X axis is to the right, and the positive direction of 
the Y axis is downward from the reference point

The line formed between the reference point and the center is regarded as the zero-degree radius of the circle.

GOT Graphic Ver.2

Movement 
range

Displayed object moved in a circular direction
+

Rotation of the object enabled

Movement 
direction

Movement 
direction

Movement 
range

Center Center

Displayed object moved in a circular direction
+

Rotation of the object disabled

Y-axis

X-axis-

-

+

+

Reference 
coordinates 
(0, 0)

Center coordinates 
(0, -100)

Center 
coordinates (100, 100)

Position of 
zero degrees

Position of 
zero degrees

Reference 
coordinates 
(0, 0)

Reference 
coordinates 
(0, 0)

When the center coordinates are (0, -100) When the center coordinates are (100, 100)
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(b) Movement range and direction
Set the start and end point angles to set the movement range and direction.
The movement range is determined by subtracting the start point angle from the end point angle.
When the movement range is 0 or more, the part moves clockwise.
When the movement range is less than 0, the part moves counterclockwise.
Add the value of the position device to change the position of the part in the moving direction.

(c) Changing the position of the part
Change the position of the part using the value of the position device.
The minimum value set for the position device corresponds to the start point and the maximum value corresponds to the 
end point.
If you change the minimum and maximum values, the position of the part differs even through the value of the position 
device remains the same.
Set the value of the position device according to the minimum and maximum values.

Center coordinates
Center coordinates of the circle: (100, -100)

Coordinates on the screen editor: (300, 100)

Parts Movement
Reference coordinates of the circle: (0, 0)
Coordinates on the screen editor: (200, 200)

(0, 0)

Position of zero degrees

X-axis

Y-axis

(200, 0) (300, 0)

(0. 200)

(0, 100)

Example) Placing a parts movement object at the coordinates (200, 200) on the screen editor and setting 
the center coordinates (100, -100)

End point angle: 
270 degrees

Position of the part 
placed for 
parts movement

Start point angle: 
0 degrees

Movement range: 270 degrees
Movement direction: Clockwise

Start point angle: 0 degrees, end point angle: 270 degrees

Start point angle: 
180 degrees
End point angle: 
-180 degrees

Movement range: 
360 degrees
Movement direction: 
Counterclockwise

Start point angle: 180 degrees, end point angle: -180 degrees
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(4) Point specification
Parts are displayed at the specified display position (point).
To set points, register a polygonal line having several points (parts movement route).
The part is displayed at the position with the same point No. as the position device value.

Set the parts movement route on screen basis. Up to 30 routes can be set for one screen.
One parts movement route can be used for multiple parts movements.

Min. value: 0, max. value: 100

Position device: D100
D100 = 50

Display position: 
135 degrees

Display position: 
45 degrees

Start point (Min. value: 0)

Min. value: 0, max. value: 300

End point 
(Max. value: 100)

End point 
(Max. value: 300)

Start point (Min. value: 0)

5 1 2

1

2

3 4

5

6

Setting image Movement image

Parts movement route
Point

Position device: D100

Parts movement A

Parts movement B

Parts movement C

Parts movement D

Route
No. 1 Used for parts movement A.

Route
No. 2

Route
No. 3

Used for parts movement B.

Used for parts movement C and D.
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■5 Display example of the parts movement
Display the parts movement as follows using the position device and parts switching device.

■6 Setting procedure of the parts movement
To set an object for the parts movement, select [Parts Switching] and then [Move Way].

Step 1 Select the switching method of parts in the [Device/Style] tab (for the fixed parts, select it in the [Style] tab).
The switching method cannot be changed after an object for the parts movement.

Step 2 Select the movement method of parts in the [Device/Style] tab (for the fixed parts, select it in the [Style] tab).
The movement method can be changed after an object for the parts movement.

To operate the parts movement with the point specification, set [Parts Move Route] prior to the objects setting for the 
parts movement.

➟8.9.7 [Parts Move Route] dialog

■7 Method of displaying BMP file parts, JPEG file parts, and PNG file parts in the data storage
BMP file parts, the JPEG file parts, and the PNG file parts can be displayed by object or project.

(1) Method of displaying by object (in the use of image files)
Specify a BMP file, JPEG file, or PNG file stored in the data storage at each object setting of the parts movement to 
display as parts.

Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.
For the storing method, refer to the following.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 When the display condition set for a parts movement to display parts is satisfied, the specified BMP file part, 

JPEG file part, or PNG file part in the data storage is displayed.
Set the following items in each [Device/Style] tab and [Style] tab (fixed parts only) of the parts movement.

• Setting image files
• Setting image file numbers

(2) Method of displaying by project
To display BMP file parts, JPEG file parts, or PNG file parts in the data storage, specify the parts No. from 9001 to 9999.
To display the BMP file parts, the JPEG file parts, or the PNG file parts in the data storage when the parts No. from 9001 
to 9999 is specified, follow the following procedure.

(a) Displaying the parts according to the setting of GT Designer3
Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 Select [Show image files in the memory card when Parts No. 9001-9999 is specified] in the [Parts Setting] 

dialog and write the setting to the GOT.

1 2 2 3

50 50 100 150

1) [Device]: D10
   [Move Way]: [Point]

Point 1 Point 2 Point 3

2) [Parts Switching Device]: [D15]
    [Parts Switching]: Parts movement (word)

Part No. 50:

Part No. 100:

Part No. 150:

1) [Device]: D10
2) [Parts Switching 
     Device]: D15

Move to point 2.
Switched to the part of 
No. 100.

Switched to the part of 
No. 150. Move to point 3.
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Step 3 When the display condition (parts number: 9001 to 9999) set for the parts movement to display parts is 
satisfied, the BMP file part, JPEG file part, or PNG file part in the data storage is displayed.

(b) When displaying BMP file parts, JPEG file parts, and PNG file parts in the data storage using 
GS450.b8
Not available to GT21 and GS21.
This method is applied to switch between the parts registered in GT Designer3 and BMP files, JPEG files, or PNG files 
in the data storage when the parts number 9001 to 9999 is specified.
To use GS450.b8, deselect [Show image files in the memory card when Parts No. 9001-9999 is specified] in the [Parts 
Setting] dialog.
If the above setting is valid, BMP files, JPEG files, or PNG files in the data storage can be used as parts regardless of 
the status of GS450.b8.

Step 1 Save the BMP file, the JPEG file, or the PNG file to be displayed as parts in the data storage.

➟5.9.3 ■6 Using the image file stored in the data storage as a part
Step 2 Turn on GS450.b8.
Step 3 When the display condition (parts number: 9001 to 9999) set for the parts movement to display parts is 

satisfied, the BMP file part, JPEG file part, or PNG file part in the data storage is displayed.

(c) Display example
The following shows a display example of when a BMP file part is stored in the data storage.

Example) Displaying BMP file parts in the parts movement (word part)
Write the parts numbers between 9001 and 9999 to a word device to display the BMP file parts.

• Word device to display the parts: D100

Parts No. GS450.b8: ON GS450.b8: OFF

9001 to 9999 Displays BMP file parts, JPEG file parts, and PNG file parts 
in the data storage. Displays the parts registered in GT Designer3

IMG0001.BMP IMG0500.BMP
IMG0999.BMP

D100     9000 D100     9001 D100     9500 D100     9999

When specifying 0 or 9000 
for the parts No., the BMP 
file parts are hidden.

The BMP file parts 
(IMG0001.BMP) is 
displayed.

The BMP file parts 
(IMG0500.BMP) is 
displayed.

The BMP file parts 
(IMG0999.BMP) is 
displayed.
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(1) When specifying a parts number other than 9001 to 9999
Even if BMP file parts, JPEG file parts, or PNG file parts in the data storage are set to be displayed, parts 
registered in GT Designer3 are displayed when a parts number out of the range between 9001 and 9999 is 
specified.

(2) When switching to BMP file parts, JPEG file parts, or PNG file parts in the data storage that 
are given the same parts number (only when using GS450.b8)
Not available to GT21 and GS21.
To switch to a part (BMP file part, JPEG file part, or PNG file part) in the data storage that has been given 
the same parts number while a part registered in GT Designer3 whose parts number is one of 9001 to 9999 
is displayed, follow the following procedure.
Step 1. Turn on GS450.b8.
Step 2. Specify either the parts number 0 or 9000 and hide the displayed part.
Step 3. Specify the parts number of BMP file parts, JPEG file parts, or PNG file parts in the data storage to 

be displayed.
(3) Example of cases where GS450.b8 is automatically turned on after the GOT is powered on

The following shows an example of cases where GS450.b8 is automatically turned on after the GOT is 
powered on.
This method is useful when using GS450.b8 and displaying BMP file parts, JPEG file parts, and PNG file 
parts in the data storage from the beginning of operation.
Step 1. As a trigger action, make the GOT internal device (device always on: GS0.b4) as a trigger condition 

and make settings that store 1 to GS450.b8 while the trigger is on.
Step 2. Store 1 in GS450.b8 with the trigger action after the GOT is powered on.

• Set in the [Project] tab of [Trigger Action].
• Set this trigger action in the first row of the list.

This stores 1 in GS450.b8 immediately after the GOT is powered on.
Parts of parts displays or parts movements at a GOT startup may not be switched to BMP file parts, 
JPEG file part, or PNG file parts.
(When the screen is switched, the parts are switched.)
Design screens under consideration for the above description.

• Select [Ordinary] for [Trigger Type].
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■8 Parts No.
Depending on the parts number, the parts that can be displayed and operations are different.
The following shows the relation between the parts numbers and the parts which can be displayed.

○: Can be displayed ×: Cannot be displayed -: Display is deleted

*1 When [Indirect Device] is set for [Detail Settings of Parts] in the [Word Parts Movement] dialog, the parts are not hidden.
(The current display is held.)
For the method of hiding parts in the [Word Parts Movement] dialog, refer to [Detail Settings of Parts] in the [Word Parts 
Movement] dialog.

➟8.9.5 ■1 [Device/Style] tab
*2 Even if the parts registered in GT Designer3 are registered, they cannot be displayed.

Example) When a part registered in GT Designer3 is registered with the parts No. 9123

■9 Setting the image data of parts to a transparent color
When a transparent color is set for the image data of set parts, the setting of the transparent color is enabled.
The following shows the method of enabling a transparent color setting for parts.

• Set a transparent color for the image data.
(Transparent colors can be set only for the image data of BMP files.)

• Register the image data for which the transparent color has been set as parts or into the library.
• Set the registered parts or library as the parts.

➟6.5 Placing and Editing Figures and Objects

Parts No.

When BMP file parts, the JPEG file parts, and PNG file parts 
in the data storage are set to be displayed

When BMP file parts, the JPEG file parts, and PNG file parts 
in the data storage are not set to be displayed

Parts registered in GT 
Designer3

BMP file parts, JPEG file 
parts, and PNG file parts in 

the data storage

Parts registered in GT 
Designer3

BMP file parts, JPEG file 
parts, and PNG file parts in 

the data storage

0 -*1 -*1 -*1 ×

1 to 8999 ○ × ○ ×

9000 × -*1 ○ ×

9001 to 9999 ×*2 ○ ○ ×

10000 to 32767 ○ × ○ ×

When BMP file parts, the JPEG file parts, 
and PNG file parts in the data storage 
are not set to be displayed.

The parts registered in GT Designer3 
(parts No. 9123) are displayed.

BMP file parts, JPEG file parts, 
and PNG file parts are displayed.

When BMP file parts, the JPEG file parts, 
and PNG file parts in the data storage 
are set to be displayed.
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8.9.3 Precautions for a parts movement object

■1 Precautions for drawing
(1) When a part overlaps with another object

Set the parts movement in a way that does not make the part overlap with another object.
Otherwise, the overlapped object may not be displayed normally.
In such a case, set the parts movement and the object in different layers.

(2) Display when a part extends off the screen
If a part is placed so that it extends off the screen, the display on the GOT differs depending on the components of the 
part and [Graphics Setting].

■2 Precautions for use
(1) Values to be stored in the position devices

If the value stored in the position device is out of the available range, the operation differs depending on the selection for 
[Move Way] in the [Device/Style] or [Style] tab.

• When [Position], [Line], or [Point] is selected for [Move Way]
The part is not moved and the previous display is held.

• When [Circle] is selected for [Move Way]
If the value is smaller than the minimum value, the display position changes according to the value set as the 
minimum value.
If the value is larger than the maximum value, the display position changes according to the value set as the 
maximum value.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display area

Parts movement (part No. 1 is displayed)

Displayed on 
the parts movement.

• When [Point] is set for [Move Way]

Part No. 1:

Part components [Graphics Setting] Part display

Image data + figures The part within the screen is displayed.

The part within the screen is displayed.
If a part extends above or left of the screen, the display differs depending on the model used as shown 
below.
• Other than GT SoftGOT2000
The figures within the screen are displayed, whereas image data even within the screen is not 
displayed.
• GT SoftGOT2000 or GT Simulator3
If the image file format is BMP or JPEG, image data within the screen is also displayed.

Image data only The part within the screen is displayed.

The part within the screen is displayed.
When an image file in the data storage is used as a part and the part extends above or left of the 
screen, system alarm 537 is output in the following cases. 
The data will not be displayed.
• Other than GT SoftGOT2000: A BMP file part, JPEG file part, or PNG file part is to be displayed.
• GT SoftGOT2000 or GT Simulator3: A PNG file part is to be displayed.

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.2

GOT Graphic Ver.1
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■3 Precautions when [Circle] is selected for [Move Way]
(1) Displaying an image file in a data storage as a part

The image file is displayed but cannot be moved in a circular direction.

(2) Displaying a part containing a character
If a character set in the [Text] dialog is contained, the character of the part is not displayed.

(3) Displaying a part containing a BMP file for which a transparent color is set
The color of the circumferential line of the BMP file may be changed due to antialiasing.
The color, if changed differently from a transparent color, does not become transparent.

(4) Display position of a part
Depending on the start or end point angle or the value of the position device, the position of the part may differ.
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8.9.4 [Bit Parts Movement] dialog

Select [Object] → [Parts Movement] → [Bit Parts] from the menu to display the setting dialog.
➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Device/Style] tab

1) [Parts Switching]
Select the parts movement type.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Parts Switching Device]
Set the device to be monitored.

➟6.1.2 How to set devices
3) [Move Format]

Select the type of the parts for the parts movement.
For the details of the parts movement type, refer to the following.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

9)

2)

3)

4)

5)

6)

7)

8)
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➟8.9.2 ■4 How to move the parts (control with the position device)

Item Description

[Device]

After setting [Move Way], set the position device that stores the destination of the part.
➟6.1 Device Settings
Depending on [Move Way], the setting items differ.
• [Position]

Set the device that stores the values of X-axis and Y-axis.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis.)

• [Line]
Set a device that stores the relative value to the start point and end point.

• [Circle]
Set a device that stores the value relative to the start and end point angle.

• [Point]
Set a device that stores the display position (point).

[Data Type]

When selecting [Line] or [Circle] for [Move Way], select the data type of the word device.
(When [Position] or [Point] is selected, the data type is fixed to [Unsigned BIN16].)
The following shows the items to be selected.
• [Unsigned BIN16]
• [Signed BIN16]

[Move Way]

Select the movement method of the parts.
• [Position]

Select this item to use the values of two word devices as the coordinates of X-axis and 
Y-axis for the parts movement.
After selecting this item, set the device that stores the coordinate position.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis.)
➟6.1 Device Settings

• [Line]
Select this item to display the parts movement on the line across the specified start point 
and end point.
After selecting this item, set the minimum value for the start point and the maximum value 
for the end point.
After the setting, perform the following operation on the screen editor.
Click the start point on the drawing screen.

Move the cursor and click the end point. The line, which is the parts movement range, is 
set.

• [Circle]

Select this item to display the circular movement of the part around the specified center 
coordinates.
After selecting this item, set the minimum value for the start point angle and the maximum 
value for the end point angel, and then set the movement route in the [Circle Route 
Setting] dialog.
For displaying the circular motion of a part, refer to the following.
➟8.9.2 ■4 (3) Circle
Click the [Circle Route Setting] button to display the [Circle Route Setting] dialog.
➟(1) [Circle Route Setting] dialog
After setting, place a parts movement object anywhere on the screen editor.

• [Point]
Select this item to display the part at the specified display position (point).
After selecting this item, set [Route No.] in the [Parts Move Route] dialog to display the 
parts movement.
The setting range is [0] to [29].
Set the parts movement route on the screen prior to the operation.
➟8.9.7 [Parts Move Route] dialog

GOT Graphic Ver.2
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4) Preview list
Displays the shapes for the on and off status.

5) [Parts Type]
Select the type of the parts for the parts movement.
When a transparent color is set for the image data of set parts, the setting of the transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.

➟8.9.2 ■9 Setting the image data of parts to a transparent color
This item is fixed to [Parts Data] when [Circle] is selected for [Move Way].

• [Parts Data]
Displays registered parts.

• [Mark Data]
Deletes the parts displayed previously and displays the new parts.
Switches the white area of the part to another display color according to the change of the parts switching 
device status.
After selecting, set [Parts No.] to be displayed as a mark.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.

➟5.9 Registering Parts ([Parts])
• [Image File]

Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟8.8.4 ■1 (1) [Image File Setting] dialog
6) [Display Mode]

Select a display method for the parts movement.
• [Movement]

Displays the parts movement deleting the displayed previously part.
• [Locus] (Not available to GT21 and GS21)

Displays the parts movement without deleting the parts that have been displayed.
Example)

As the setting is fixed to [Movement], no additional setting is required accordingly.

The following shows selectable items.
• [Movement]
• [Locus]

7) [Alignment]
Select the reference of the parts display position.

[Route No.] Set [Route No.] in the [Parts Move Route] dialog to display the parts movement.
The setting range is [0] to [29].

Item Description

When [Locus] is selected

Previous display Previous display

The previous display is deleted.The previous display is deleted.

When [Movement] is selected

GOT Graphic Ver.2

GOT Graphic Ver.1
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• [Top-Left]
Displays the part using the top-left coordinate of the part as the reference.

• [Center]
Displays the part using the center coordinate of the part as the reference.

Example)
When [Position] is selected in [Move Way] (X-axis coordinate device = 320, Y-axis coordinate device = 240)

When [Line] is selected in [Move Way] (Device: D100 = 50)

When [Circle] is selected for [Move Way] (Center coordinates: 0, -100)

When [Point] is selected in [Move Way] (Device: D200 = 4)

8) [Detail Settings of Parts]
Select the type of the parts for the parts movement.

Item Description

[Parts No.]

Set the parts number to be displayed.
Click the [Parts] button to check the registered parts.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from the white.

[Image File No.]

Specify an image file number.
The range which can be specified depends on [Digits] in the [Image File Setting] dialog.
• When [Digits] is [5]: [0] to [65535]
• When [Digits] is [4]: [0] to [9999]
• When [Digits] is [3]: [0] to [999]
• When [Digits] is [2]: [0] to [99]
• When [Digits] is [1]: [0] to [9]
When 0 is set for [Screen File No.], images are deleted.
When displaying only images for the on status, set 0 for [Image File No.] for the off status.

X-axis coordinate device X-axis coordinate device

Y-axis
coordinate

device

Y-axis
coordinate

device

Top left Center

Start point Start pointEnd point End point

Top left Center

Center coordinates
(0, -100)

Center coordinates
(0, -100)

Top left Center

1

2

3

4

1

2

3

4

Top left Center
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9) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(1) [Circle Route Setting] dialog
Set a movement route when moving a part circularly.
For how to use the center coordinates and movement range, refer to the following.

➟8.9.2 ■4 (3) Circle

1) [Central Coordinate]
Set the center coordinates of a circle.
The following shows the items to be selected.

• [X-Position]: [-5000] to [5000]
• [Y-Position]: [-5000] to [5000]

Set the center coordinates relative to the coordinates at which a parts movement object is placed.
The line formed between the points (coordinates of the parts display object and the center coordinates) is regarded 
as the zero-degree radius of the circle.

2) [Moving Range]
Set the start and end point angles to determine the movement range and direction for the part.
The following shows the items to be selected.

• [Starting Angle]: [-360.0] to [360.0]
• [Ending Angle]: [-360.0] to [360.0]

The angle is settable in units of 0.1 degree.
The angle increases clockwise from zero degrees.

3) [Rotate the object itself]
Rotates the part at the same angle in the same direction as the parts movement display settings based on the 
position selected for [Alignment] in the [Device/Style] or [Style] tab.
The minimum rotation angle of the part is one degree.

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

Item Description

1)

2)

3)
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■2 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ Upon the setting change

y ○ ○ Upon the setting change

[Device/Style]

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.9.5 [Word Parts Movement] dialog

Select [Object] → [Parts Movement] → [Word Parts] from the menu to display the setting dialog.
➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Operation/Script] tab

■1 [Device/Style] tab

1) [Parts Switching]
Select the switching method of parts.
The following shows the items to be selected.

• [Bit]
• [Word]

2) [Parts Switching Device]
Set the device to be monitored.

➟6.1.2 How to set devices

3) [Data Type]
Select the data type of the device to be set.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

15)

2)

5)

4)

3)

10)

11)

6)
7)
8)

12)

9)
14)

13)

D10: 1 D10: 2 D10: 3

Part No. 1
is displayed.

Part No. 2
is displayed.

Part No. 3
is displayed.
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4) [Move Format]
Select a movement type for parts movement.
For the details of the parts movement type, refer to the following.

➟8.9.2 ■4 How to move the parts (control with the position device)

Item Description

[Device]

After setting [Move Way], set the position device that stores the destination of the part.
➟6.1.2 How to set devices
Depending on [Move Way], the setting items differ.
• [Position]

Set the device that stores the values of X-axis and Y-axis.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis.)

• [Line]
Set a device that stores the relative value to the start point and end point.

• [Circle]
Set a device that stores the value relative to the start and end point angle.

• [Point]
Set a device that stores the display position (point).

[Data Type]

When selecting [Line] or [Circle] for [Move Way], select the data type of the word device.
(When [Position] or [Point] is selected, the data type is fixed to [Unsigned BIN16].)
The following shows the items to be selected.
• [Unsigned BIN16]
• [Signed BIN16]
8 - 384 8. OBJECT FUNCTION
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5) Preview list
Displays set conditions.

6) Add button
Adds a new condition.

7) Delete button
Deletes the selected condition.

8) Up button, down button
Changes the order of priority of the selected condition.

9) [Utilize] button
Creates a new condition utilizing the selected condition.

10) [Parts Type]
Select the type of the parts for the parts movement.
When a transparent color is set for the image data of set parts, the setting of the transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.

[Move Way]

Select the movement method of the parts.
• [Position]

Select this item to use the values of two word devices as the coordinates of X-axis and 
Y-axis for the parts movement.
After selecting this item, set the device that stores the coordinate position.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis.)
➟6.1.2 How to set devices

• [Line]
Select this item to display the parts movement on the line across the specified start point 
and end point.
After selecting this item, set the minimum value for the start point and the maximum value 
for the end point.
After the setting, perform the following operation on the screen editor.
Click the start point on the drawing screen.

Move the cursor and click the end point. The line, which is the parts movement range, is 
set.

• [Circle]

Select this item to display the circular movement of the part around the specified center 
coordinates.
After selecting this item, set the minimum value for the start point angle and the maximum 
value for the end point angel, and then set the movement route in the [Circle Route 
Setting] dialog.
For displaying the circular motion of a part, refer to the following.
➟8.9.2 ■4 (3) Circle
Click the [Circle Route Setting] button to display the [Circle Route Setting] dialog.
➟8.9.4 ■1 (1) [Circle Route Setting] dialog
After setting, place a parts movement object anywhere on the screen editor.

• [Point]
Select this item to display the part at the specified display position (point).
After selecting this item, set [Route No.] in the [Parts Move Route] dialog to display the 
parts movement.
The setting range is [0] to [29].
Set the parts movement route on the screen prior to the operation.
➟8.9.7 [Parts Move Route] dialog

[Route No.] Set [Route No.] in the [Parts Move Route] dialog to display the parts movement.
The setting range is [0] to [29].

Item Description

GOT Graphic Ver.2
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➟8.9.2 ■9 Setting the image data of parts to a transparent color
This item is fixed to [Parts Data] when [Circle] is selected for [Move Way].

11) [Display Mode]
Select a display method for the parts movement.

• [Movement]
Displays the parts movement deleting the displayed previously part.

• [Locus] (Not available to GT21 and GS21)
Displays the parts movement without deleting the parts that have been displayed.

Example)

As the setting is fixed to [Movement], no additional setting is required accordingly.

The following shows selectable items.
• [Movement]
• [Locus]

12) [Alignment]
Select the reference of the parts display position.

• [Top-Left]
Sets the display position using the top-left coordinate of the part as the reference.

• [Center]
Sets the display position using the center coordinate of the part as the reference.

Example)
When [Position] is selected in [Move Way] (X-axis coordinate device = 320, Y-axis coordinate device = 240)

Item Description

[Parts Data] Displays registered parts.

[Mark Data]

Switches the white area of the registered part to another display color according to the 
change of the device status.
After selecting, set [Parts No.] to be displayed.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.
➟5.9 Registering Parts ([Parts])

[Image File]
Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟8.8.4 ■1 (1) [Image File Setting] dialog

When [Locus] is selected

Previous display Previous display

The previous display is deleted.The previous display is deleted.

When [Movement] is selected

GOT Graphic Ver.2

GOT Graphic Ver.1

X-axis coordinate device X-axis coordinate device

Y-axis
coordinate

device

Y-axis
coordinate

device

Top left Center
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When [Line] is selected in [Move Way] (Device: D100 = 50)

When [Circle] is selected for [Move Way] (Center coordinates: 0, -100)

When [Point] is selected in [Move Way] (Device: D200 = 4)

13) [Range]
• [Bit]

Select this item when changing the display according to the on and off status of the bit device.
After selecting, set the bit device and device status (ON, OFF).

• [Word]
Select this item when changing the display according to the value of a word device.
After selecting, set the conditional expression for the value of the word device with [Range] button.

14) [Detail Settings of Parts]
When the setting of [Detail Settings of Parts] is not [Indirect Device], conditions are required to be set.
The following shows how the parts are switched according to the setting of [Detail Settings of Parts] and set 
conditions.

For the details of conditions, refer to the following.

[Detail Settings of Parts]
Condition setting

Enabled None

Indirect device

Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Depending on the value of the parts 
switching device, parts are switched and 
displayed.

Set a condition as required.
Depending on the monitor device value, parts 
are switched and displayed.
Set a condition when switching parts 
according to the other conditions.

[Parts No.] Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Displays the parts set for [Detail Settings of 
Parts].

Make sure to set a condition.
Otherwise, only one type of parts is displayed 
continuously.
Switching to another part cannot be 
performed.

[Mark Color]

[Hold]

Depending on a set condition, parts are 
displayed as follows.
• When a condition is satisfied

Displays the parts set for the condition.
• When a condition is not satisfied

Holds the display of the parts set for the 
condition.

Make sure to set a condition.
Without the setting of a condition, nothing is 
displayed.

Start point Start pointEnd point End point

Top left Center

Center coordinates
(0, -100)

Center coordinates
(0, -100)

Top left Center

1

2

3

4

1

2

3

4

Top left Center
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➟6.5.5 ■2 Setting conditions

15) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Indirect Device]

Display the [Parts No.] corresponding to the value of the parts switching device.
If the parts switching device value is 0 (0 or 9000 for the BMP file parts, JPEG file parts, 
PNG file parts in the data storage), the current display is held.
When deleting the parts, set $V==0 for [Range].

[Parts No.]

Set the parts to be displayed.
Click the [Parts] button to check the registered parts.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from the white.

[Image File No.]

Specify an image file number.
The range which can be specified depends on [Digits] in the [Image File Setting] dialog.
• When [Digits] is [5]: [0] to [65535]
• When [Digits] is [4]: [0] to [9999]
• When [Digits] is [3]: [0] to [999]
• When [Digits] is [2]: [0] to [99]
• When [Digits] is [1]: [0] to [9]
When 0 is set for [Screen File No.], images are deleted.

[Hold] Select this item to hold the current display of the parts.

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

The parts of the part No. 100
are displayed.

Monitor device value

D200: 100
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■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15]. If you do not use the security function, select [0].

2) [Use offset]
Select this item to monitor multiple devices by switching them.
Set the offset device with the [Setting] button.

3) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3) 4)
8. OBJECT FUNCTION
8.9 Placing a Parts Movement

8 - 389



■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Operation/Script] tab

Depending on the selection for [Operation Type], the setting items are different.

(1) [Data Operation]

This item can be set only when [Operation Type] is [Data Operation].
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Select the format of the expression operating with the data operation.
The following shows the items to be selected.

• [None]
• [Data Expression]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]
• [Right]

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
8. OBJECT FUNCTION
8.9 Placing a Parts Movement

8 - 391



(2) [Script]

This item can be set only when [Operation Type] is [Script].
For the settings of scripts, refer to the following.

➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ Upon the setting change

y ○ ○ Upon the setting change

[Device/Style]

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.9.6 [Fixed Parts Movement] dialog

Select [Object] → [Parts Movement] → [Fixed Parts] from the menu to display the setting dialog.
➟■1 [Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Script] tab

■1 [Style] tab

1) [Move Format]
Select a movement type for parts movement.
For the details of the parts movement type, refer to the following.

➟8.9.2 ■4 How to move the parts (control with the position device)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Device]

After setting [Move Way], set the position device that stores the destination of the part.
➟6.1.2 How to set devices
Depending on [Move Way], the setting items differ.
• [Position]

Set the device that stores the values of X-axis and Y-axis.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis)

• [Line]
Set a device that stores the relative value to the start point and end point.

• [Circle]
Set a device that stores the value relative to the start and end point angle.

• [Point]
Set a device that stores the display position (point).

[Data Type]

When selecting [Line] or [Circle] for [Move Way], select the data type of the word device.
(When [Position] or [Point] is selected, the data type is fixed to [Unsigned BIN16].)
The following shows the items to be selected.
• [Unsigned BIN16]
• [Signed BIN16]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

6)

5)
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2) [Parts Type]
Select the type of the parts for the parts movement.
When a transparent color is set for the image data of set parts, the setting of the transparent color is enabled.
For the method of enabling the transparent color setting of parts, refer to the following.

➟8.9.2 ■9 Setting the image data of parts to a transparent color
This item is fixed to [Parts Data] when [Circle] is selected for [Move Way].

[Move Way]

Select the movement method of the parts.
• [Position]

Select this item to use the values of two word devices as the coordinates of X-axis and 
Y-axis for the parts movement.
After selecting this item, set the device that stores the coordinate position.
The set device and the following device are set to store the coordinates of X-axis and Y-
axis. (The set device is for storing the coordinate of X-axis)
➟6.1.2 How to set devices

• [Line]
Select this item to display the parts movement on the line across the specified start point 
and end point.
After selecting this item, set the minimum value for the start point and the maximum value 
for the end point.
After the setting, perform the following operation on the screen editor.
Click the start point on the drawing screen.

Move the cursor and click the end point. The line, which is the parts movement range, is 
set.

• [Circle]

Select this item to display the circular movement of the part around the specified center 
coordinates.
After selecting this item, set the minimum value for the start point angle and the maximum 
value for the end point angel, and then set the movement route in the [Circle Route 
Setting] dialog.
For displaying the circular motion of a part, refer to the following.
➟8.9.2 ■4 (3) Circle
Click the [Circle Route Setting] button to display the [Circle Route Setting] dialog.
➟8.9.4 ■1 (1) [Circle Route Setting] dialog
After setting, place a parts movement object anywhere on the screen editor.

• [Point]
Select this item to display the part at the specified display position (point).
After selecting this item, set [Route No.] in the [Parts Move Route] dialog to display the 
parts movement.
The setting range is [0] to [29].
Set the parts movement route on the screen prior to the operation.
➟8.9.7 [Parts Move Route] dialog

[Route No.] Set [Route No.] in the [Parts Move Route] dialog to display the parts movement.
The setting range is [0] to [29].

Item Description

[Parts Data] Displays registered parts.

[Mark Data]

Switches the white area of the registered part to the color set for [Mark Color].
After selecting, set [Parts No.] to be displayed.
The setting range is [0] to [32767].
Click the [Parts] button to check the type of the registered parts.
For the parts that can be displayed by mark, refer to the following.
➟5.9 Registering Parts ([Parts])

Item Description

GOT Graphic Ver.2
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3) [Display Mode]
Select a display method for the parts movement.

• [Movement]
Displays the parts movement deleting the displayed previously part.

• [Locus]
Displays the parts movement without deleting the parts that have been displayed.
Example)

As the setting is fixed to [Movement], no additional setting is required accordingly.

The following shows selectable items.
• [Movement]
• [Locus]

4) [Alignment]
Select the reference of the parts display position.

• [Top-Left]
Displays the part using the top-left coordinate of the part as the reference.

• [Center]
Displays the part using the center coordinate of the part as the reference.
Example)
When [Position] is selected in [Move Way] (X-axis coordinate device = 320, Y-axis coordinate device = 240)

When [Line] is selected in [Move Way] (Device: D100 = 50)

[Image File]
Select an image file registered in the data storage to display the file as a part.
Click the [Setting] button and select an image file in the [Image File Setting] dialog.

➟8.8.4 ■1 (1) [Image File Setting] dialog

Item Description

When [Locus] is selected

Previous display Previous display

The previous display is deleted.The previous display is deleted.

When [Movement] is selected

GOT Graphic Ver.2

GOT Graphic Ver.1

X-axis coordinate device X-axis coordinate device

Y-axis
coordinate

device

Y-axis
coordinate

device

Top left Center

Start point Start pointEnd point End point

Top left Center
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When [Circle] is selected for [Move Way] (Center coordinates: 0, -100)

When [Point] is selected in [Move Way] (Device: D200 = 4)

5) [Detail Settings of Parts]

6) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Parts No.]

Set the parts number to be displayed.
Click the [Parts] button to check the registered parts.
The setting range is [0] to [32767].
When 0 is set for [Parts No.], the part is deleted.
When displaying only parts and screens for the on status, set 0 for [Parts No.] for the off 
status.

[Mark Color] When selecting [Mark Data] for [Parts Type], select the color of the area of the part to be 
switched from the white.

[Image File No.]

Specify an image file number.
The range which can be specified depends on [Digits] in the [Image File Setting] dialog.
• When [Digits] is [5]: [0] to [65535]
• When [Digits] is [4]: [0] to [9999]
• When [Digits] is [3]: [0] to [999]
• When [Digits] is [2]: [0] to [99]
• When [Digits] is [1]: [0] to [9]
When 0 is set for [Screen File No.], images are deleted.
When displaying only images for the on status, set 0 for [Image File No.] for the off status.

[Blink]

Select the blinking speed of the parts.
The following shows the items to be selected.
• [None]
• [Low]
• [Medium]
• [High]

Center coordinates
(0, -100)

Center coordinates
(0, -100)

Top left Center

1

2

3

4

1

2

3

4

Top left Center
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■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15]. If you do not use the security function, select [0].

2) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

3) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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■3 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
For details of each item, refer to the following.

➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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■4 [Script] tab

For the settings of scripts, refer to the following.
➟9.10 Object Script

(1) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 (Object 
stacking order adjustment 

enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 (Object 
stacking order adjustment 

disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ Upon the setting change

y ○ ○ Upon the setting change

[Style]

[Parts No.] part_no ○ ○ Upon the setting change

[Mark Color] mark_color ○ ○ Upon the setting change

[Blink] blink ○ ○ Upon the setting change

[Extended] [Security Level] security ○ ○ When the object is updated When the screen is updated
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8.9.7 [Parts Move Route] dialog

To operate [Move Way] using [Point], set the parts movement route, in which the parts are displayed.
Up to 30 routes can be set for one screen.
One parts movement route can be used for multiple parts movements.

Step 1 Select [Object] → [Parts Movement] → [Parts Move Route] from the menu.
Step 2 The [Parts Move Route] dialog appears.

➟■1 [Parts Move Route] dialog
Step 3 Click the mark (+) which is displayed on the drawing screen to place point 1.

Click the mark to finish creating the necessary points.

Step 4 When the setting is completed, the point numbers are displayed on the set positions.

• Changing the point position
Click the parts movement route and select [Edit Points] from the right-click menu.
In the vertex edit mode, drag the point to change its position.

• Changing the number of points and the route No.
Double-click the parts movement route to display the setting dialog. Change [Points] and [Route No.].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Click.

Click.

Vertex edit mode Drag the point to change its position.
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■1 [Parts Move Route] dialog

1) [Route No.]
Set [Route No.] of [Parts Move Route] to be created.
The setting range is [0] to [29].

2) [Points]
Set the number of points of the movement position (the position to display the parts).
The setting range is [1] to [100].

3) [Arrange in a line]
The parts are moved on a line.
Points are automatically placed for the number of points set in [Points] by specifying the start point and end point.

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

8.9.8 Relevant settings

Set the relevant settings other than the specific settings for the parts movement as required.
The following shows the functions that are available by the relevant settings.

■1 Parts setting
Select [Common] → [Parts] → [Parts Setting] from the menu to display the [Parts Setting] dialog.

➟5.9.6 [Parts Setting] dialog

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

1 2 43 5

 Example) Number of points: 5

Specify the start point and end point.
(Point 2 to point 4 are automatically placed.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Setting whether to use image files in the data storage for parts displays or parts 
movements

[Show image files in the memory card when Parts No. 
9001-9999 is specified]

Function Setting item

Using image files in the data storage as parts for parts displays or parts movements (Read 
device) GS450.b8
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8.10 Placing a Historical Data List Display

With this function, device data can be displayed in a list in chronological order.
➟9.2 Collecting Device Data ([Logging])

8.10.1 Specifications of the historical data list display

■1 Maximum number of objects on one screen
The maximum number of objects on one screen depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to eight historical data list displays can be placed on one screen.

• For GT21 and GS21
One historical data list display, trend graph, scatter graph, or historical trend graph can be placed on one screen.

■2 Relation between historical data list displays and logging
For the logging, refer to the following.

➟9.2 Collecting Device Data ([Logging])

(1) Contents displayed by historical data list displays
The data collected or accumulated in buffering areas or data storage by the logging is displayed as a list with this function.
As the accumulated data are available, current and past information can be displayed as a list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Oct. 8, 2013 12:25:00

Oct. 8, 2013 12:30:00

Oct. 8, 2013 12:35:00

Oct. 8, 2013 12:40:00

Oct. 8, 2013 12:45:00

Oct. 8, 2013 12:50:00

Oct. 8, 2013 12:55:00

Oct. 8, 2013 13:00:00

Oct. 8, 2013 13:05:00

Oct. 8, 2013 13:10:00

Oct. 8, 2013 13:15:00

Oct. 8, 2013 13:20:00

Oct. 8, 2013 13:25:00

Oct. 8, 2013 13:30:00

Oct. 8, 2013 13:35:00

Oct. 8, 2013 13:40:00

Oct. 8, 2013 13:45:00

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

57

91

65

53

67

77

83

75

62

88

86

87

73

85

60

71

64

3

8

4

3

2

1

5

4

6

2

7

6

4

3

2

1

0

Oct. 8, 2013 12:25:00

Oct. 8, 2013 12:30:00

Oct. 8, 2013 12:35:00

Oct. 8, 2013 12:40:00

Oct. 8, 2013 12:45:00

Oct. 8, 2013 12:50:00

Oct. 8, 2013 12:55:00

Oct. 8, 2013 13:00:00

Oct. 8, 2013 13:05:00

Oct. 8, 2013 13:10:00

Oct. 8, 2013 13:15:00

Oct. 8, 2013 13:20:00

Oct. 8, 2013 13:25:00

Oct. 8, 2013 13:30:00

Oct. 8, 2013 13:35:00

Oct. 8, 2013 13:40:00

Oct. 8, 2013 13:45:00

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

57

91

65

53

67

77

83

75

62

88

86

87

73

85

60

71

64

3

8

4

3

2

1

5

4

6

2

7

6

4

3

2

1

0

Oct. 8, 2013 13:50:00 100 65 2

Oct. 8, 2013 13:55:00 100 55 3

Oct. 8, 2013 14:00:00 100 52 3

Oct. 8, 2013 12:25:00

Oct. 8, 2013 12:30:00

Oct. 8, 2013 12:35:00

Oct. 8, 2013 12:40:00

Oct. 8, 2013 12:45:00

Oct. 8, 2013 12:50:00

Oct. 8, 2013 12:55:00

Oct. 8, 2013 13:00:00

Oct. 8, 2013 13:05:00

Oct. 8, 2013 13:10:00

Oct. 8, 2013 13:15:00

Oct. 8, 2013 13:20:00

Oct. 8, 2013 13:25:00

Oct. 8, 2013 13:30:00

Oct. 8, 2013 13:35:00

Oct. 8, 2013 13:40:00

Oct. 8, 2013 13:45:00

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

100

57

91

65

53

67

77

83

75

62

88

86

87

73

85

60

71

64

3

8

4

3

2

1

5

4

6

2

7

6

4

3

2

1

0

Displays the latest data.

List
display
range

Past data

Latest data

List
display
range

Past data

Latest data

Data collected with
the logging function Past data

Latest data

List
display
range

Usually displays the latest data. Displays past data.

Date and time Target figure Actual figure
Number of

defective products

Oct. 8, 2013 13:35:00 100 60 2

Oct. 8, 2013 13:40:00 100 71 1

Oct. 8, 2013 13:45:00 100 64 0

Latest
Cursor up Cursor downHide cursorShow cursor

Top Bottom

Date and time Target figure Actual figure
Number of

defective products

Oct. 8, 2013 13:50:00 100 65 2

Oct. 8, 2013 13:55:00 100 55 3

Oct. 8, 2013 14:00:00 100 52 3

Latest
Cursor up Cursor downHide cursorShow cursor

Top Bottom

Date and time Target figure Actual figure
Number of

defective products

Oct. 8, 2013 12:40:00 100 53 3

Oct. 8, 2013 12:45:00 100 67 2

Oct. 8, 2013 12:50:00 100 77 1

Latest
Cursor up Cursor downHide cursorShow cursor

Top Bottom

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Logging data

Displays accumulated data in a list.

11:35:00
11:40:00
11:45:00
11:50:00
11:55:00
12:00:00

18:05:00
:

Date and time Target figure Actual figure Number of
defective products

Oct. 8, 2013 11:40:00 100 55 3

Oct. 8, 2013 11:45:00 100 72 6

Oct. 8, 2013 11:50:00 100 66 6
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(2) Logging data which can be displayed with historical data list displays
One historical data list display corresponds to only one logging ID number for the display of data.
To display multiple logging ID numbers, set the same number of historical data list displays.

(3) A logging setting required when historical data list displays are used
Make sure that the set value of [Number of Logs a file] in the relevant logging setting is equal to or larger than the set 
value of [Display Rows] in the historical data list display setting to secure performance.

➟8.10.4 ■1 [Display] tab

(4) Consistency check
The consistency between the setting of a historical data list display and the corresponding logging setting is checked at 
the following timing.

• When the dialog for a historical data list display is opened
• When devices of a historical data list are enabled and a data check is conducted

■3 Display when a data operation error occurs
For the data operation, if a BCD-BIN conversion error or a division by zero error occurs, the object displays hyphens 
corresponding to the number of displayed digits.

(1) Display of a value containing a symbol or decimal point
A symbol and a decimal point, which are contained in a value, are also displayed as hyphens.
Example) When the settings are configured as follows: display format: real, number of displayed digits: 5 (fractional 
portion: 2), and right alignment

8.10.2 How to use the historical data list display

■1 Placing the historical data list display
Place historical data list displays on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing historical data list displays
Edit historical data list displays that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

11.11
22.22
33.33

No.1
2014/09/05 22:00

Date
12.34
56.78
90.12

No.2

2014/09/05 22:00
2014/09/05 22:00

------
No.1

2014/09/05 22:00
Date No.2

2014/09/05 22:00
2014/09/05 22:00

------
------
------

------
------

Display at an error occurrenceNormal display

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Setting historical data list displays
Set historical data list displays that have been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
Setting historical data list displays
The following outlines the procedure for setting a historical data list display.
Example)
A historical data list display that displays target figures and actual figures
D10, D20, and D30 are logged in a trigger sampling cycle of 300000 ms.

➟8.10.4 [Historical Data List Display] dialog
9.2 Collecting Device Data ([Logging])

Step 1 Set the number of rows and columns to be displayed, the device to be monitored, and the items to be 
monitored in the [Display] tab.

Step 2 Set the font, text size, ruled line, spacing, and figure in the [Text/Style] tab.

Step 3 Set the security level, time of the cursor position, and time of the display position in the [Extended] tab if 
necessary.

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production 
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

1) 6)5)4)3)2) 1) Date and time: Displays the date and time when the logging data is obtained. 

2) Target figure: Monitors the value in D10. 

3) Actual figure: Monitors the value in D20. 

4) Production rate: Displays the value that derives from 
                               "Actual figure ÷ Target figure × 100". (0 to 100.0%)

5) Number of defective products: Monitors the value in D30. 

6) Defect rate: Displays the value that derives from 
                        "Number of defective products ÷ Actual figure × 100". (0 to 100.0%)

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

A B
Old

logging
data

New
logging

data

A Date column
    Date and time stored in the logging data
B Data column
    Device values are displayed
    according to the device setting.

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Producton
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

[Shape]

[Draw Ruled Line]

[Up/Down Scroll List Displacement]
Set the number of rows for scroll operations.

[Font], [Text Size]

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

The time in the cursor position can be stored
in a device and the display position time
can be specified and displayed.
8 - 404 8. OBJECT FUNCTION
8.10 Placing a Historical Data List Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

■4 Displaying and moving the cursor
The cursor can be displayed and moved in the list with a key code switch.
With the setting of [Single Touch Operation], the cursor can be displayed directly on and moved to a touched position.
When [Time Device] in the [Extended] tab of [Historical Data List Display] is set, a selected date and time are stored in a 
set device.

➟8.10.4 ■3 [Extended] tab

■5 Displaying data obtained at a specified time
The data obtained at a specified time can be displayed with a key code switch.
When [Display Position Time Device] in the [Extended] tab of the [Historical Data List Display] dialog is set, the data of a 
specified time is displayed in the center of the list of the historical data list display.

➟8.10.4 ■3 [Extended] tab
When the data of a specified time is displayed, the update of the list stops.

Date and time

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Target figure

100

100

100

100

100

100

100

Actual figure

72

66

81

55

64

68

75

Production
rate (%)

Number of
defective products

Defect
rate (%)

72.0

66.0

81.0

55.0

64.0

68.0

75.0

6

6

6

3

5

4

6

8.3

9.1

7.4

5.5

7.8

5.9

8.0

[Time Device]
Device value: Oct. 8, 2013 12:00:00

Date and time

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Target figure

100

100

100

100

100

100

100

Actual figure

72

66

81

55

64

68

75

Production
rate (%)

Number of
defective products

Defect
rate (%)

72.0

66.0

81.0

55.0

64.0

68.0

75.0

6

6

6

3

5

4

6

8.3

9.1

7.4

5.5

7.8

5.9

8.0

Date and time

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Target figure

100

100

100

100

100

100

100

Actual figure

72

66

81

55

64

68

75

Production
rate (%)

Number of
defective products

Defect
rate (%)

72.0

66.0

81.0

55.0

64.0

68.0

75.0

6

6

6

3

5

4

6

8.3

9.1

7.4

5.5

7.8

5.9

8.0

Oct. 8, 2010 12:00:00

Time to be specified

The data obtained at the specified time can be displayed
in the center of the list.
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■6 Conjunction with historical trend graphs
By setting the same device to [Time Device] of historical data list displays and [Display Position Time] of historical trend 
graphs, the data obtained at time specified with a historical data list display can be displayed in a historical trend graph.

➟8.10.4 ■3 [Extended] tab
8.16 Placing a Trend Graph

Example) Displaying the data obtained at time specified with a historical data list display in a historical trend graph
Make the following settings.

• Set [D1000] for [Time Device] of the [Historical Data List Display] dialog.
• Set [D1000] for [Display Position Time] of the [Historical Trend Graph].
Step 1 Display the cursor in the historical data list display and move the cursor to the data to be displayed in the 

historical trend graph.
The time is stored in the time device (D1000). (Device value: specified time)

Step 2 Enter the key code of the display position time specification jump (FFD4h) with a touch switch. The data 
obtained at the time stored in [Display Position Time Device] (D1000) is displayed in the historical trend 
graph.

Displaying data of historical trend graphs in historical data list displays
By setting the same device to [Time Device] of historical trend graphs and [Display Position Time Device] of 
historical data list displays, the data obtained at time specified with a historical trend graph can be displayed in 
a historical data list display.

➟8.10.4 ■3 [Extended] tab
8.16 Placing a Trend Graph

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production 
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

0

100

12:10 12:15 12:20 12:25 12:30
0

10
Historical Data List Display Historical Trend Graph

Time data is stored 
in the time storage device. Oct. 8, 2010

12:00:00

D1000

Actual figure

Number of 
defective products

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

0

100

11:50 11:55 12:00 12:05 12:10

0

10

Historical Trend Graph

Time
specification

jump

Historical Data List Display

Displays the time stored in the display 
position time specification device.

Oct. 8, 2010
12:00:00

D1000

Actual
figure

Number of 
defective products
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■7 Touch switches for historical data list displays
Touch switches for the historical data list display are available by reading from the library of GT Designer3.
The characters and shapes on the touch switches can be changed by a user.
When key codes are set for touch switches, touch switches for the historical data list display can be created by a user.

Touch switch Key code Description

Show cursor

FFF0h

Displays or deletes the cursor.
Displays the cursor in the center of the list.Hide cursor

FFF1h

List Cursor Up

FFF2h

Moves the cursor upward or downward.
List Cursor Down

FFF3h

List Displacement Scroll Up

FFF4h

Scrolls the cursor to the row a specified number of rows below or above.
By setting [Up/Down Scroll List Displacement], the number of the rows between the original 
position and destination can be changed.
➟8.10.4 ■2 [Text/Style] tab

List Displacement Scroll 
Down

FFF5h

List Page Scroll Up

FFF6h

Scrolls the cursor to the row a specified number of rows displayed in the list below or above.
List Page Scroll Down

FFF7h

Jump to the top of the list

FFD0h Moves the cursor to the top of the list.

Jump to the bottom of the list

FFD1h Moves the cursor to the bottom of the list.

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Oct. 8, 2013 12:10:00

Oct. 8, 2013 12:15:00

Oct. 8, 2013 12:20:00

Oct. 8, 2013 12:25:00

Target figure

100

100

100

100

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

68

75

66

57

Production
rate (%)

Number of
defective products

Defect
rate (%)

68.0

55.0

72.0

66.0

81.0

55.0

64.0

68.0

75.0

66.0

57.0

5

3

6

6

6

3

5

4

6

5

3

7.4

5.5

8.3

9.1

7.4

5.5

7.8

5.9

8.0

7.6

5.3

Touch switches for the 
historical data list display
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■8 Operations performed using the object gesture function
The display of objects can be operated using gestures.
For operations with gestures, refer to the following.

➟11.13 Operating Objects by the Gesture (Object Gesture Function)

8.10.3 Precautions for a historical data list display object

■1 When changing the logging devices of the logging settings or utilizing data of another 
project for logging

If the logging devices of the logging settings are changed or the data of another project for logging is utilized after a 
historical data list display is set, the device of the logging setting may not match the device of the historical data list 
display.
In this case, set the device of the historical data list display again.
When the device type does not match, the historical data list display is not displayed.

■2 Placing historical data list displays when setting the single touch operation
When setting [Single Touch Operation] in the [Extended] tab of the [Historical Data List Display] dialog, set the size of the 
part displayed in the list to a multiple of 16.
If a set size is not a multiple of 16, or a point not in the succession of a multiple of 16 is touched, the following irregularities 
may occur.

• The cursor is displayed in a position away from a touched point.
• Touches do not receive any response.

■3 Display viewed when the bit is selected for the device type
When the bit is selected for the device type, the screen editor always displays the off status even if the display is switched 
to on.
In the GOT, the monitor device is displayed correctly.

■4 Displaying data which cannot be processed as real numbers
When [Real] is set for [Display Format] and the data to be displayed cannot be processed as real numbers, what are 
displayed depends on the values.

• If all the values are 0: [Inf] is displayed.
• If values are not 0: [NaN] is displayed.

For how to set [Display Format], refer to the following.
➟8.10.4 ■1 [Display] tab

Latest Data

FFEFh Displays the latest data.

Move display position to the 
specified time

FFD4h Displays in the center the data obtained at the time stored in the display position time 
specification device. (Time specification jump function)

Touch switch Key code Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
8 - 408 8. OBJECT FUNCTION
8.10 Placing a Historical Data List Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

■5 Displaying an integer as a real number
For a device capable of storing an integer only, configure the following settings to display the device value as a real 
number.

Example) When the number of decimal places is 2
In [Data Operation], set the operational expression: $$/100.
When the target device stores 12345, the displayed value is 123.45.

■6 Precautions for the use of the time specification jump function
(1) When using the time specification jump function

If the time specification jump function is used, the update processing of the list stops.
To resume the update processing, touch a touch switch for which the key code (FFEFh) is set.

(2) When carrying out another operation while a time specification jump is performed
While the data obtained at a specified time is searched with the time specification jump function, the operations with 
functions other than the historical data list display cannot be performed.

(3) When multiple values of logging data are obtained around a specified time
If logging data are not obtained at a specified time, the data obtained at the nearest time is searched.
When the multiple values are obtained at the nearest time, the first detected value is displayed.

(4) When displaying the data obtained at the start of logging and the data obtained around the time when 
the latest data is obtained
When the logging data obtained at a specified time is the one obtained at the start of the logging or the data obtained 
around the time when the latest data is obtained, the data to be displayed may not be displayed in the center of the 
historical data list display.

(5) When performing a time specification jump without specifying time
When performing a time specification jump without specifying time (all the settings of [Display Position Time Device] are 
0), the update processing stops and the latest data is displayed.
To resume the update processing, touch a touch switch for which the key code (FFEFh) is set.

(6) When there is no logging data that can be displayed in historical data list displays
When there is no logging data that can be displayed in a historical data list display, no time specification jump is 
performed.

(7) When the logging data to be displayed are not shown in chronological order
When the logging data to be displayed are not shown in chronological order due to a time change of the GOT's clock, the 
data obtained at the time the nearest to a specified time may not be displayed.

Item Settings

[Device Type] in the logging setting

Select one of the following items.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]

[Display Format] in the [Display 
Setting] dialog Select [Real].

[Data Operation]
Set the operational expression: $$/(10 to the n-th power).
The symbol $$ represents a device value, and the letter n represents the 
number of decimal places.
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8.10.4 [Historical Data List Display] dialog

Step 1 Select [Object] → [Historical Data List Display] from the menu.
Step 2 Click the position where you place the historical data list display. Placing the historical data list display is 

complete.
Step 3 Double-click the historical data list display which has been placed to display the setting dialog.

➟■1 [Display] tab
■2 [Text/Style] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Display] tab

1) [Display Rows]
Set the number of rows excluding the title row.
The setting range is [1] to [47].

2) [Display Columns]
Set the number of the data columns.
The setting range is [1] to [32].

3) [Sort Setting]
Select the method of sorting out the rows to be displayed.
The following shows the items to be selected.

• [Latest]
• [Oldest]

4) [Title]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Input Method]

Select the method of setting the text to be displayed in the title.
The following shows the items to be selected.
• [Direct]
• [Comment]

[Group No.]
Only when [Comment] is selected for [Input Method], this item can be set.
Set the comment group number to be used.
The setting range is [1] to [500].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

5)

6)

7)

2)
3)
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5) [Device]

6) [Display]

[Adjust Text Size]
Only when [Comment] is selected for [Input Method], this item can be set.
The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size]
This item can be set only when [Adjust Text Size] is set.
Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dots.

Item Description

[Logging ID]

Set the logging ID number to be displayed.
The setting range is [1] to [32767].
When the [Edit] button is clicked, the [Logging] dialog appears and the logging ID number 
can be edited.
➟9.2 Collecting Device Data ([Logging])

[Device Setting]

Select the setting method for [No. Logging Device].
The following shows the items to be selected.
• [Continuous]: Set the number of successive devices counted from a set first device. The 

number of successive devices is the same as that of logging blocks.
• [Random]: Set the number of devices one by one.

Item Description

Edit button

Edits display columns or others.

• [Insert Data Column] button
Inserts a new column on the left of a selected data column.

• [Cut] button
Cuts a selected data column.

• [Copy] button
Copies a selected data column or character string.

• [Paste] button
Pastes a cut or copied data column or character string.

• [Delete] button
Deletes a selected data column.

[Date/Data Column No.] Displays the data column numbers of the number of the columns set for [Date] and [Display 
Columns].

[Digits]

Set the number of the digits displayed in each column.
The following shows the setting range.
• [Date]: [5] to [100]
• Data column No.: [1] to [100]

[Title Text]

Set the title of each column.
Depending on the selection in [Input Method], the setting items are different.
• If [Direct] is selected for [Input Method]:

Enter the title in the text box directly.
• If [Comment] is selected for [Input Method]:

Set a comment No. or a comment.
The setting range is [1] to [32767].

[Change Status (Text)]

Displays whether the format of the title has been changed or not.
• [Changed]
• [Not changed]
Click the [...] button to display the [Text Format] dialog.
The format of the title is user-changeable.

➟(1) [Text Format] dialog

[No. Logging Device]

In the [Device List] dialog, select a logging device of a selected logging ID number.
When a logging device is selected in the [Device List] dialog, the order of the logging device 
and the device are displayed.

Item Description

[Insert Data Column] button
[Cut] button

[Copy] button
[Paste] button

[Delete] button

Setting order of the logging device Logging device
8. OBJECT FUNCTION
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7) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(1) [Text Format] dialog

1) [Alignment]
Set the vertical or horizontal position of the text.

2) [Text Color]
Set the text color.

➟6.4.2 Color settings
3) [Bold] button

Displays the text in bold.
4) [Solid] button

Displays the text with a shadow.
5) [Raised] button

Displays the text embossed.
6) [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

[Device Type] Displays the device type selected for [No. Logging Device].

[Display Setting]

Depending on the column to be set, the setting item differs.
• If the [Date] column is set:

Set the display format of the date and time for [Date/Time Setting].
➟6.3 Date/Time Format Settings

• If a data column is set:
Set the display format of the device and numerical value in the [Display Setting] dialog.
➟(2) [Display Setting] dialog (historical data list display)

[Display Format] Displays the setting of [Display Format] in the [Display Setting] dialog.

[Data Operation]

Set an expression in the [Edit Data Expression] dialog.
Signed BIN16 is applied to the data type of the device set for the expression of this item.

➟6.5.5 ■4 Setting data operations
When no expression is set, [None] is displayed.
For a device capable of storing an integer only, refer to the following to display the device 
value as a real number.

➟8.10.3 ■5 Displaying an integer as a real number

[Change Status (Text)]

Displays whether the format of the data column has been changed or not.
• [Changed]
• [Not changed]
When you select [Changed], the [Text Format] dialog appears.
The format of the data column is user-changeable.

➟(1) [Text Format] dialog

Item Description

1)

2)

3)
4)

5)

6)
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(2) [Display Setting] dialog (historical data list display)

1) [Display Format]
Select the display type of the device to be monitored.
The selectable items vary with the data type of the device.
○ : Available, ×: Not available

2) [Digits]
Set the number of the digits of the numerical values to be displayed.
The setting range depends on the setting of [Display Type].

• [Signed Decimal] or [Unsigned Decimal]: [1] to [21]
• [Hexadecimal]: [1] to [16]
• [Octal]: [1] to [6]
• [Binary] or [Real]: [1] to [32]

3) [Decimal Point]
Set the number of digits to the right of the decimal point to be displayed.
The setting range is [0] to [30].
This item can be set only when [Format] is [Real].
If there are digits to the right of a set rightmost digit, the value is rounded off and displayed.
When 0 is set, the value is rounded off to the first decimal place.
Example) When the device value is 6.57, and [Decimal Point] is set to [1]

[Data Type]
[Format]

[Signed Decimal] [Unsigned 
Decimal] [Hexadecimal] [Octal] [Binary] [Real]

[Signed BIN16] ○ ○ ○ ○ ○ ○

[Unsigned BIN16] ○ ○ ○ ○ ○ ○

[Signed BIN32] ○ ○ ○ × ○ ○

[Unsigned BIN32] ○ ○ ○ × ○ ○

[Signed BIN64] ○ ○ ○ × × ○

[Unsigned BIN64] ○ ○ ○ × × ○

[Signed BIN8] ○ ○ ○ ○ ○ ○

[Unsigned BIN8] ○ ○ ○ ○ ○ ○

[BCD16] ○ ○ ○ ○ ○ ○

[BCD32] ○ ○ ○ × ○ ○

[BCD64] ○ ○ ○ × × ○

[Real(32bit)] ○ ○ ○ × ○ ○

[Real(64bit)] ○ ○ ○ × × ○

1)
2)
3)
4)

5)

6.6 6.57

6.57
Rounds off.
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4) [Fill with 0]
Prefixes a numerical value with 0 and displays it.
Example) When the device value is 5 and [Digits] is set to [5]

5) [Preview]
Displays the preview of the screen.

■2 [Text/Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Font]
Select the font of the displayed text.
The following shows the items to be selected.

• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

2) [Text Size]
Set the text size to be displayed.

➟1.2.5 Font specifications

Item Description

[Sample Value] Set the numerical value to be displayed in the preview.

5 00005

If prefixed with 0If not prefixed with 0

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

6)

7)

9)

8)

5)

10)

2)

3) 4)
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3) [Display the comments in Windows fonts]
Displays the following registered comments in Windows fonts.

• Comments set for the titles in the [Display] tab (when [Comment] is selected for [Specification])
4) [Windows Font Setting]

Displays the [Comment Group Property] dialog to list the properties of the comment group specified with [Group 
No.] in the [Display] tab.
Set [Windows Font] and [Character Set] for the target column of the comment group.

➟5.8.4 ■2 (1) [Comment Group Property] dialog
5) [Data (Text Format)]

This item is settable only when [String] is selected for [Device Type] in any column on the [Display] tab.

6) [Cursor Color]
Select the color of the cursor used for selecting logging data.

➟6.4.2 Color settings
7) [Scrolling Increment]

Set the number of the rows for scroll operations on the list performed when the key cords for scrolling the list (up/
down) (FFF4h, FFF5h) are entered.
The setting range is [1] to [27].

8) [Draw Ruled Line]

9) [Space]
Set the space between the text or time display to be displayed and the ruled line of the table.
The setting range is [0] to [32].
The actually displayed space is defined by the setting of [Text Size] as follows.
Setting value of [Text Size] × setting value of [Space]
Example)
When setting [Text Size] to [2] and [Space] to [8]

10) [Shape Settings]

Item Description

[Adjust Text Size] Automatically adjusts the text size according to the object size.
When this item is not selected, a line feed is automatically added to the text.

[Minimum Size] Set the minimum text size applied when the text size is automatically adjusted.
The setting range is [8] dots to [240] dots.

[Preview Text] Set the text to be previewed on the screen editor.

Item Description

[Style]

Select the style of ruled lines.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

[Width]

Select the width of ruled lines.
• [1Dot]
• [2Dot]
• [3Dot]
• [4Dot]
• [5Dot]
• [7Dot]

[Line Color]
Set the ruled line color.
➟6.4.2 Color settings

Item Description

[Shape]
Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 ■1 Setting object shapes

Occurrence date and time

16 dots
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

2) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
With the setting of user ID, each object can have an ID number (user ID) and the target ID (object) for an operation 
can be specified with a touch switch. Hence touch switch operations can be performed as required.

[Frame Color]
Select the frame color of the shape.
➟6.4.2 Color settings

[Shape Color]
Select the color of the shape.
➟6.4.2 Color settings

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

6)
7) 8)

4)

5)
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To specify the user ID of the object to be operated with a touch switch, set [User ID for a key input] or [Individually 
set user ID for key input].
For touch switches, refer to the following.

➟8.2.4 [Switch] dialog
8.2.11 [Key Code Switch] dialog

3) [Single Touch Operation]
Displays the cursor in the touched position directly.

4) [Time Device]

*1 Method of storing in devices
Time is stored in the upper eight bits and lower eight bits of a set device.
Example) When setting D100

*2 Monitoring set devices
When monitoring a device with a numerical display, select [BCD16], [BCD32], or [BCD64] for [Data Type], and 
set [Bit Mask] and [Bit Shift] of [Data Operation] as follows.
Example) Example of numerical display settings

Item Description

[Cursor Position Time] Writes the date and time displayed in the position where the cursor is displayed to a device as BCD data.
Set a device for [Device] in which the date and time are stored.

[Device]

Set a device in which the date and time are stored.*1*2*3*4Set a GOT internal device for this item.
When a controller device is used, the monitor speeds may become slow.
➟6.1.2 How to set devices
12.1 GOT Internal Device

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Target figure

50

50

50

Actual figure

45

40

32

Number of
defective products

3

0

1

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Target figure

100

100

100

Actual figure

68

55

72

Number of
defective products

5

3

6

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Target figure

50

50

50

Actual figure

45

40

32

Number of
defective products

3

0

1

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Target figure

100

100

100

Actual figure

68

55

72

Number of
defective products

5

3

6

Historical
data list display A

(User ID: 1)

If user ID is not set

The touch switches for historical data list display A 
work for historical data list display B.

If user ID is set

Historical
data list display B

Historical
data list display A

Historical
data list display B

(User ID: 2)

(User ID: 1) (User ID: 2)

Touch switches
for historical data

list display A

Touch switches
for historical data

list display B

Although the same key codes are used, the target
for an operation can be specified with ID numbers. 
Hence operations can be performed as required.

Touch switches
for historical data

list display A

Touch switches
for historical data

list display B

Show cursor

Hide cursor

Latest data

Show cursor

Hide cursor

Latest data

Show cursor

Hide cursor

Latest data

Show cursor

Hide cursor

Latest data

(0: Sunday, 1: Monday, 2: Tuesday, 3: Wednesday, 4: Thursday, 5: Friday, 6: Saturday)

D100 b15 to b8 b7 to b0

(Year) (Month)

D101 b7 to b0b15 to b8

(Time)(Day)

D102 b7 to b0b15 to b8

(Second)(Minute)

D103 b7 to b0b15 to b8

(Day of the week)Not used
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*3 Timing with which data is stored in devices
With the following timings, data is stored.
· When the cursor is displayed in the list
· When the displayed cursor is moved
· When the cursor is displayed and the historical data list display is operated with a touch switch

*4 Values to be stored in devices
If the cursor is displayed in the list, the update processing of the list stops.
Into a device, the value of the data and time displayed in the position where the cursor is displayed at the 
processing stop is stored.
Example) Storing a date and time into a device

5) [Display Position Time Device]

Item Description

[Display Position Time] Displays the data of a specified date and time. (Time specification jump function)
Set a device for [Device] in which a specified date and time are stored.

When displaying the year (upper 8 bits)

Lower 8 bits of D100 (b7 to b0): Masked
Upper 8 bits of D100 (b15 to b8): Shifted to the right by 8 bits

When displaying the Month (Lower 8 bits)

Upper 8 bits of D100 (b15 to b8): Masked

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Target figure

100

100

100

100

100

100

100

Actual figure

68

55

72

66

8

55

64

Number of
defective products

5

3

6

6

6

3

5

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Oct. 8, 2013 12:05:00

Target figure

100

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

64

Number of
defective products

5

3

6

6

6

3

5

Stores the time
displayed
where the
cursor is placed.

Show
cursor

Cursor
move

Stores the time 
displayed where 
the cursor is placed.

Data displayed where the cursor is placed at the instant 
when a draw processing stops is stored with the timing 
that the cursor is displayed/moved.

Example) Storing time in the device
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*1 Place the following objects on the screen and set them.

[Device]

Set a device in which a specified date and time are stored.
➟6.1.2 How to set devices
The successive devices from a set device are set to store the data of year and month, day and hour, and 
minute and second.
By using [Display Position Time Device] and a touch switch, the logging data obtained at a specified date 
and time can be displayed in the center of the historical data list display. (The cursor is displayed in the 
position of the logging data obtained at a specified time.)
If logging data are not obtained at a specified date and time, the logging data obtained at the nearest 
date and time is displayed.
• Specification of the time which can be set

The data type is BCD16 (binary coded decimal).
The data range varies with the GOT model.
GT27, GT25, GT23, and GS25: Jan. 1, 2000 to Dec. 31, 2099
GT21 and GS21: Jan. 1, 2000 to Dec. 31, 2037

• Required settings*1

• Operation example
The following shows an example of a time specification jump function operation.
Example) When setting D1000 as the display position time specification device and displaying the data 
of Oct.8, 2010 11:45:00

For precautions of the time specification jump function, refer to the following.
➟8.10.3 Precautions for a historical data list display object

Object Settings

Switch, key code switch

Read from the library of GT Designer3 or create them.
➟8.10.2 ■5 Displaying data obtained at a specified time
When creating the objects, set [Action] of [Code Setting] to [Display Position Time Device] 
for each object.
➟8.2 Placing a Touch Switch

Historical Data List Display
Select [Display Position Time] in the [Extended] tab and set a device.
➟■3 [Extended] tab

Item Description

Date and time

Oct. 8, 2013 11:35:00

Oct. 8, 2013 11:40:00

Oct. 8, 2013 11:45:00

Oct. 8, 2013 11:50:00

Oct. 8, 2013 11:55:00

Oct. 8, 2013 12:00:00

Target figure

100

100

100

100

100

100

Actual figure

68

55

72

66

81

55

Number of
defective products

5

3

6

6

6

3

Display position time device

Set the time to be displayed
in the display position time device.

Year and month
(D1000)

15 bits

0x10

0x08

0x45

0x10

0x11

0x00

0 bit

Day and time
(D1001)
Minute and second
(D1002)

Time
specification

jump

The data obtained at the specified time
(Oct. 8, 2010 11:45:00) can be displayed 
in the center of the list.

Touch the touch switch for 
which the key code (FFD4h) 
has been set.
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6) [KANJI region]
Select the KANJI region of the displayed text.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

7) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

8) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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8.10.5 Relevant settings

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT Designer3
Always enabled.

[Adjust object display order in GOT to the one in GT 
Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.11 Placing an Alarm Display
For how to place and set the alarm display, refer to the following.

➟9.1.5 Viewing alarm events (Alarm display)
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8.12 Placing a Simple Alarm Display

With this function, a user-created comment can be displayed as an alarm message when an alarm occurs.
When multiple devices turn on, a comment is displayed in the order in which comments are set.

For details of alarms, refer to the following.
➟9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

8.12.1 Specifications of the simple alarm display

■1 Maximum number of objects arrangeable on one screen
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 24 objects can be placed.
• For GT21 and GS21

One object can be placed.

■2 Detecting alarm occurrences and resets
Alarm occurrences and resets are detected only while the GOT displays a screen on which a simple alarm display object 
is placed.
If you switch the screen having no simple alarm display object to another screen having a simple alarm display object, 
the time of screen switching is displayed as the time of occurrence of an alarm event.
To detect alarm events regardless of the displayed screen, use an alarm display (user) object.

➟9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

■3 Displaying the time of occurrences
For the time of occurrences, the clock data of the GOT is used.
For the precautions and restrictions of the clock function which manages the GOT clock data, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])

■4 Comments displayed in simple alarm displays
For the comments to be displayed, use a comment group.
For details of the comment group, refer to the following.

➟5.8 Comment Setting ([Comment])

8.12.2 How to use the simple alarm display

■1 Placing the simple alarm display
Place simple alarm displays on the screen editor.

➟6.5.1 Placing figures and objects

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

M100: OFF → ON
M101: OFF → ON

Detail

M100 Temperature anomaly

M101 Fuse error
Replace the fuse 
of the power 
supply unit.

Detail

M100 Temperature anomaly

M101 Fuse error

Touch!

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Editing simple alarm displays
Edit simple alarm displays that have been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting simple alarm displays
Set simple alarm displays that have been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
Simple alarm display settings

➟8.12.4 [Simple Alarm Display] dialog

■4 Number of alarms on display
Select whether to display just one of alarms that have occurred or display more.

➟8.12.4 ■1 [Device] tab
• Displaying multiple alarms

One alarm is displayed in one row.
The part that cannot be displayed within a row is not displayed.
A comment that involves multiple rows cannot be displayed from its second row.

When multiple alarms are displayed, any one of multiple rows that a comment involves can be set as the target for 
the display.
Example) Displaying any one of six rows that a registered comment involves

[Number of Comments]: [Multiple] Display range

Oct. 8, 2013 13:52:15 Frame deliveries
Oct. 8, 2013 11:35:52 Temperature anomaly
Oct. 8, 2013 09:45:30 Fuse error

[Number of Comments]: [Single]

The range of the rows to be displayed can be specified.

Oct. 8, 2013 13:52:15 Check 2
Processed product check

[Number of Comments]: [Multiple]
Display
range

Oct. 8, 2013 13:52:15 Check 2
Oct. 8, 2013 11:35:52 Temperature anomaly
Oct. 8, 2013 09:45:30 Fuse error

Only one row can be specified for the display.

Comment with multiple rows

Display method of the comment
Row from which the comment is displayed: 3
Number of displayed rows: 2 
(only when [Single] is set for [Number of Comments])

Check 1

Conveyor check
Check 2
Processed product
check

Check 3

Line check
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• Displaying one alarm
The part that overflows from the first row goes down to the next line.
A comment that involves multiple rows is displayed in more than two rows as long as the comment length is within 
the display range.

■5 Display order
Set the type of the order in which multiple alarms are displayed.
By the setting, alarms can be displayed in order of time of their occurrences or device number.

➟8.12.4 ■2 [Style] tab
Example) When displaying alarms in order of time of occurrences from the latest

[Number of Comments]: [Single] Display range

Oct. 8, 2013 13:52:15 Frame delivery 
complete 
When the delivery stop status is 
canceled, deliveries resume.

Oct. 8, 2013 11:35:52 Temperature anomaly
Oct. 8, 2013 09:45:30 Fuse error
Oct. 8, 2013 08:15:45 Oil error

Oct. 8, 2013 11:35:52 Temperature anomaly

[Number of Comments]: [Multiple] [Number of Comments]: [Single]

Alarm status

Oct. 8, 2013 11:35:52 Temperature anomaly
Oct. 8, 2013 09:45:30 Fuse error
Oct. 8, 2013 08:15:45 Oil error
Oct. 8, 2013 05:22:35 Fuel error
Oct. 8, 2013 04:33:12 Internal pressure error
Oct. 8, 2013 02:30:16 Timing belt error

M2
M4
M0
M3
M5
M1
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■6 Scroll
The part of a comment that extends off the display range can be checked by scrolling the simple alarm to the part.
To perform scrolling, create a touch switch for the system alarm.

➟■9 Touch switches for simple alarm displays

■7 About the detail display
The detail display can be set only when [Multiple] is selected for [Number of Comments] in the [Device] tab.

➟8.12.4 ■1 [Device] tab

(1) Available screens
When setting the causes of alarms and corrective actions as the target for the detail display, the screen used for the 
display can be selected from three types.

(a) Comment window
Displays a comment a user registers.
In the detail display, a comment different from the one for the simple alarm can be displayed.

Oct. 8, 2013 11:35:52 Temperature anomaly

Oct. 8, 2013 11:35:52 Temperature anomaly Oct. 8, 2013 11:35:52 Temperature anomaly

Oct. 8, 2013 09:45:30 Fuse error

Oct. 8, 2013 09:45:30 Fuse error

Oct. 8, 2013 13:52:15 Frame deliveries

Oct. 8, 2013 08:15:45 Oil error

Oct. 8, 2013 13:52:15 Frame delivery 
complete 
When the "delivery stop status" is canceled, 
deliveries resume.

Up scroll Down scroll

Up scroll Down scroll

Up scroll Down scroll

Up scroll Down scroll

Scrolls to
each row
one by 
one.

Scrolls to 
the alarm
display one
row below.

[Number of Comments]: [Multiple] [Number of Comments]: [Single]

Base screen 1 + Comment window

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error

Base screen 1

A temperature 
anomaly has occurred 
in the power supply
unit of line 1.
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(b) Base screen
Displays a specified base screen.

(c) Window screen
Displays a specified window screen.
A specified window screen can be displayed using overlap window 1.

(2) Relation between the screen where the simple alarm is set and the screen used for the detail display
Switching: Switches the screen where the simple alarm is set to the screen used for the detail display.
Simultaneous display: Leaves displayed the screen where the simple alarm is set and displays the screen used for the 
detail display.

Base screen 5

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

Base screen 1

Tank control screen
Tank A Tank B Tank C

90°C 40°C 60°C

RUN STOP RUN STOP RUN STOP

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error

Base screen 1 + Window screen 10

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

Base screen 1

Charge the feed stock 
from the slot.

Slot

Screen for which the simple alarm is set
Screen for the detail display

Comment window Window screen Base screen

Base screen

Simultaneous display

Simultaneous display Switching

Overlap window 1 Switching

Simultaneous display

Overlap window 2

Simultaneous display

Overlap window 3

Overlap window 4

Overlap window 5

Superimpose window 1

Superimpose window 2
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(3) Specify the comment number to be displayed or the offset value of the screen number
When [Detail No. Offset] in the [Device] tab is set, the offset value for the detail display can be specified.

➟8.12.4 ■1 [Device] tab
The targets which can be specified by the offset value for the detail display are as follows.

• Comment number to be displayed in the comment window
• Base screen numbers and window screen numbers

While monitoring with the GOT, you can switch the comment number or screen number with a device.
Example) When setting D0 for [Detail No. Offset] and registering comments as follows.

Changing comments of the simple alarm
Comments of the simple alarm cannot be changed in [Detail No. Offset].
When changing a comment of the simple alarm with an offset device, set [Comment No. Offset] in the [Extended] 
tab.
➟8.12.4 ■3 [Extended] tab

Comment No. Comment

1 A temperature anomaly has occurred in the power supply unit of line 1.
Check the power supply unit.

2 Replace the fuse of the power supply unit of line 1.

.

.

.

.

.

.

11 A temperature anomaly has occurred in the power supply unit of line 2.
Check the power supply unit.

12 Replace the fuse of the power supply unit of line 2.

 
Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

A temperature anomaly 
has occurred in the power 
supply unit of line 1. 
Check the power supply unit.

A temperature anomaly 
has occurred in the power 
supply unit of line 2. 
Check the power supply unit.

Comment No.1 is displayed. Comment No.11 is displayed.

Detail Detail

D0 0 D0 1010
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(4) Display method
Select the method of displaying the detail display from the following two types.

(a) Touch operation
Touch the simple alarm directly to display the detail display.

➟■8 Operating by touching the simple alarm directly

(b) Touch switch
Create a touch switch for the detail display to display the detail display.

➟■9 Touch switches for simple alarm displays

■8 Operating by touching the simple alarm directly
By setting [Touch Mode] in the [Device] tab, the following operations can be performed.

➟8.12.4 ■1 [Device] tab
• Selecting [Selection] for [Touch Mode].

An alarm can be selected at the direct touch of the simple alarm display.

• Selecting [Operation] for [Touch Mode]
The detail display can be displayed at the direct touch of the simple alarm display.

Oct. 8, 2013 16:13:01 Temperature anomaly
Oct. 8, 2013 15:51:38 Fuse error
Oct. 8, 2013 10:25:16 Oil error 

A temperature anomaly
has occurred in the 
power supply unit 
of line 1.

Display

Delete

Display the cursor. Move the cursor to the alarm
for the detail display (upward/downward).

Display the detail display.

DetailUpward

Downward

Oct. 8, 2013 16:13:01 Temperature anomaly

Oct. 8, 2013 15:51:38  Fuse error

Oct. 8, 2013 10:25:16  Oil error

Display

Delete

DetailUpward

Downward

Oct. 8, 2013 16:13:01  Temperature anomaly

Oct. 8, 2013 15:51:38  Fuse error

Oct. 8, 2013 10:25:16  Oil error

Display

Delete

DetailUpward

Downward

Oct. 8, 2013 16:13:01  Temperature anomaly

Oct. 8, 2013 15:51:38  Fuse error

Oct. 8, 2013 10:25:16  Oil error

Replace the fuse 
of the power supply
unit of line 1.

Fuse error
Oct. 8, 2013 14:25:17
Oct. 8, 2013 15:20:41

Oil error

Oct. 8, 2013 16:51:15 Temperature anomaly

The touched alarm is selected.

When the alarm is touched again, the selection of the alarm is canceled.

Fuse error
Oct. 8, 2013 14:25:17
Oct. 8, 2013 15:20:41

Oil error

Oct. 8, 2013 16:51:15 Temperature anomaly
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■9 Touch switches for simple alarm displays
Touch switches for the simple alarm display is available by reading from the library of GT Designer3.
The characters and shapes on the touch switches can be changed by a user.
When key codes are set for touch switches, touch switches for the simple alarm display can be created by a user.

➟8.2.4 [Switch] dialog
8.2.11 [Key Code Switch] dialog

Fuse error
Oct. 8, 2013 14:25:17
Oct. 8, 2013 15:20:41

Oil error

Oct. 8, 2013 16:51:15 Temperature anomaly

The touched alarm is selected.

When the alarm again is touched again, the detail display is displayed.

Fuse error
Oct. 8, 2013 14:25:17
Oct. 8, 2013 15:20:41

Oil error

Oct. 8, 2013 16:51:15 Temperature anomaly

Replace the fuse of 
the power supply unit.

Touch switch Key code Description

Scroll up by one line

00F2h

Switches the display between one row above and one row below.
This function is available only when the cursor is hidden.

Scroll down by one line

00F3h

Show cursor

FFB0h

Displays or deletes the cursor.

Hide cursor

FFB1h

Application example 1 Application example 2

Scroll to the one row below!
Oct. 8, 2013 13:54:45
Oct. 8, 2013 14:25:17

Fuel error

Oct. 8, 2013 15:20:41 Fuse error
Oil error

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Display the cursor!

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly
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Move cursor upward

FFB2h

• When the cursor is hidden
Displays the previous page or next page. (by page)

• While the cursor is displayed
Moves the cursor upward or downward. (by row)

Move cursor downward

FFB3h

Display detail

FFB8h

Displays the detail screen for a selected alarm.

Display ladder (Sequence 
Program Monitor (iQ-R/iQ-L 
Ladder))

FFBAh

Initiates the coil search and factor search for an alarm device automatically in a specified 
program file and displays the device in the sequence program monitor. (One-touch ladder jump 
function)
Specify the search mode and the program file to be searched in the [User Alarm Observation] 
dialog.

➟9.1.2 ■7 [User Alarm Observation] dialog

Display ladder (Sequence 
Program Monitor (Ladder)) FFBDh

Display ladder (Sequence 
Program Monitor (iQ-F  
Ladder))

FFC3h

Touch switch Key code Description

Display the next page!

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Internal pressure error
Oct. 8, 2013 11:11:12

Oct. 8, 2013 13:54:45
Oct. 8, 2013 12:23:11

Motor error

Fuel error

Move the cursor!

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Display the detail screen!

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly
A temperature anomaly 
has occurred in the power
supply unit. 
Check the power supply 
unit.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The ladder monitor screen of the specified device is displayed.

M999
MOV     1     D1

MOV     2     D2
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Touch switches working differently depending on the display status
There are touch switches working differently depending on the display status.
When the cursor is hidden, the move cursor upward (FFB2h) and move cursor downward (FFB3h) display the 
previous page and next page respectively by page. When the cursor is hidden, they move the cursor upward and 
downward respectively by row.

■10 Operations performed using the object gesture function
The display of objects can be operated using gestures.
For operations with gestures, refer to the following.

➟11.13 Operating Objects by the Gesture (Object Gesture Function)

Display ladder 

FFBCh

Not available to GT21 and GS21.
Initiates the coil search and factor search for an alarm device automatically in a specified 
program file.
The hit is displayed on one of the following screens. (One-touch ladder jump function)
• Ladder monitor screen of the FX ladder monitor
• Ladder monitor screen of the sequence program monitor (Ladder)
Specify the search mode and the program file to be searched in the [User Alarm Observation] 
dialog.

➟9.1.2 ■7 [User Alarm Observation] dialog

Display first alarm FFBFh

Displays the first of the alarms, which are sorted in the order set for [Sort], in the top row.
While the cursor is being displayed, touching this touch switch hides the cursor.
Example) When [Latest] is selected for [Sort]

Touch switch Key code Description

↑ ↓ ← →

MOV  1   D1

MOV  2   D2

K

K

M999

Display the sequence program monitor! 
(The ladder of the specified device is displayed.)

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Fuse error
Oct. 8, 2013 14:25:17

Oct. 8, 2013 16:51:15
Oct. 8, 2013 15:20:41

Oil error

Temperature anomaly

Display the first alarm!

Internal pressure error
Oct. 8, 2013 13:54:45
Oct. 8, 2013 12:23:11

Fuel error
Oct. 8, 2013 14:25:17 Oil error
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8.12.3 Precautions for a simple alarm display object

■1 Text display in the row where the cursor is inserted
If the pattern of the background color of the screen or [Shape Color] in the [Style] tab is set to white, the text color and 
cursor color are shown in the same color, and the text in the row where the cursor is inserted becomes invisible.
To display the text in the row where the cursor is inserted, set the background color of the screen or [Shape Color] in the 
[Style] tab to a color other than white.

➟8.12.4 ■2 [Style] tab
2.5.1 Creating a screen

■2 Monitoring array-type global labels
When [Continuous] is selected for [Device No.] in the [Simple Alarm Display] dialog ([Device] tab) and an array-type 
global label is set, the device assigned for monitoring may not be monitored properly.

• Directly set the device assigned to the global label for the simple alarm display.
• Select [Random] for [Device No.] in the [Simple Alarm Display] dialog ([Device] tab).
• Use a multiple of 8 to set the number of array elements for the global label on GX Works3.

■3 Monitoring a primitive data type global label set using the consecutive device setting (one 
point)

When [Continuous] is selected for [Device No.] in the [Simple Alarm Display] dialog ([Device] tab) and a primitive data 
type global label is set with one device point, the system alarm (326: The data type of labels/tags do not match.) occurs.
To solve the above problem, take one of the following corrective actions.

• Select [Random] for [Device No.] in the [Simple Alarm Display] dialog ([Device] tab).
• Set an array-type global label.

8.12.4 [Simple Alarm Display] dialog

Step 1 Select [Object] → [Alarm Display] → [Simple Alarm Display] from the menu.
Step 2 Click the position where you place the simple alarm display. Placing the simple alarm display is complete.
Step 3 Double-click the simple alarm display which has been placed to display the setting dialog.

➟■1 [Device] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Device] tab

1) [Alarm Points]
Set the number of devices to be monitored.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [8192].

• For GT21 and GS21
When [Continuous] is selected for [Device No.], the setting range is [1] to [1024].
When [Random] is selected for [Device No.], the setting range is [1] to [512].

2) [Comment]

Item Description

[Comment Group] Set the comment group number to be used.
The setting range is [1] to [500].

[Number of Comments]

Select the number of comments to be displayed in the display frame.
The following shows the items to be selected.
• [Multiple]
• [Single]

[Head Comment No.]

Set the comment number displayed when an alarm occurs.
The setting range is [1] to [32767].
The comment number set for this item is assigned to the start device in the device tab.
From the number set for this item, numbers are set successively. The number of the set successive 
numbers is the same as that of the devices to be monitored.
Example)
Start device: M100
[Head Comment No.]: 1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

5)

Monitored device Comment No. (basic comment)

M100 .............. 1 Temperature anomaly

M101 .............. 2 Fuse error

M102 .............. 3 Oil error

Head comment No.
The comments that have given 
the successive Nos. counted from 
the head comment No. are set.
8 - 434 8. OBJECT FUNCTION
8.12 Placing a Simple Alarm Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

3) [Detail]

Item Description

[Display Destination]

This item can be selected only when [Multiple] is selected for [Comment].
Select the setting method of the detail display.
The following shows the items to be selected.
• [Not Display]:

Does not display the detail display.
• [Comment Window]:

Displays the detail display in the window for the detail display.
In the comment window, registered comments are displayed.

• [Base Screen]
Displays a base screen for the detail display.

• [Window Screen]
Displays a window screen for the detail display.
The window screen is displayed using overlap window 1.

The following shows the method of displaying the comment window.
• Number of characters that can be displayed in a comment window

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 429 one-byte characters (11 lines of 39 characters) are displayed.
Up to 209 one-byte characters (11 lines of 19 characters) are displayed.

• For GT2107-W, GT2105-Q, GT2104-R, and GS21
Up to 161 one-byte characters (7 lines of 23 characters) are displayed.
Up to 77 two-byte characters (7 lines of 11 characters) are displayed.

• For GT21-P
Up to 203 one-byte characters (7 lines of 29 characters) are displayed.
Up to 98 two-byte characters (7 lines of 14 characters) are displayed.

• Display position of the comment window
A comment window is displayed on the base screen.
The window can be moved and closed in the same way that operates window screens.

• Display of comments
Text size is fixed to one time high and one time wide.
Regardless of the settings made when comments are registered, a blink and HQ characters are not 
displayed.

• Display of comment rows
From the top left of the comment window, the registered comments are displayed.
When a comment is longer than the display range of the comment window, the comment is wrapped 
around to be displayed.
To display the comment in the center of the comment window, adjust the position of the comment by 
inserting line feeds.

       Operation not ready
       Wait approximately 6 minutes.

When the comment is registered

When the comment window is viewed

Operation not ready
Wait approximately 6 minutes.
8. OBJECT FUNCTION
8.12 Placing a Simple Alarm Display

8 - 435



4) [Device]

5) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Detail]

When [Comment Window], [Base Screen], or [Window Screen] is selected for [Display Destination], this 
item can be selected.
Select the method of setting comment numbers, window screen numbers, or base screen numbers.
The following shows the items to be selected.
• [Continuous]:

Sets successive comment numbers, window screen numbers, or base screen numbers starting from a 
set comment number, window screen number, or base screen number.

• [Random]
Sets numbers one by one.

[Comment Group]
This item can be selected only when [Comment Window] is selected for [Display Destination].
Set the comment group assigned to the comment to be displayed in the comment window.
The setting range is [1] to [500].

Item Description

[Device No.]

Select the display method of the device to be monitored.
The following shows the items to be selected.
• [Continuous]: Sets successive devices starting from a set device.
• [Random]: set device numbers one by one.

[Device]
Set the device to be monitored.
➟6.1.2 How to set devices

[Detail]

When [Comment Window], [Base Screen], or [Window Screen] is selected for [Display Destination], this 
item can be selected.
Set a comment number, window screen number, and base screen number.
The setting range is [1] to [32767].

[Comment Selection]
Displays the comment and screen title set for [Detail No.] of [Device].
A comment number, window screen number, or base screen number can be set by selecting a comment 
or screen title for this item.

[Generated Number Storage]
Set a device in which the number of alarms that have occurred (number of devices that have turned on) 
is stored.
➟6.1.2 How to set devices

[Detail No. Offset]

When [Comment Window], [Base Screen], or [Window Screen] is selected for [Display Destination], this 
item can be set.
The display of the detail display can be switched with a single device value.
The data length of the set device is fixed to 16 bits.
The device value set for this item is added to the comment number, base screen number, or window 
screen number set for [Detail No.] of [Device].
➟6.1.11 Offset

[Touch Mode]

This item can be selected only when [Multiple] is selected for [Comment].
Select the operation performed when the simple alarm display is touched.
The following shows the items to be selected.
• [None]

Disables touch operations.
• [Selection]

Selects a touched alarm.
• [Operation]

Displays the detail screen of a touched alarm.

Item Description
8 - 436 8. OBJECT FUNCTION
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■2 [Style] tab

1) [Shape Settings]

2) [Display Format]

Item Description

[Shape]
Select the shape to be set for the object from the list or with the [Shape] button.
➟6.5.5 ■1 Setting object shapes

[Frame Color]
Select the frame color of the shape.
➟6.4 Color Settings

[Shape Color]
Select the color of the shape.
➟6.4 Color Settings

Preview Displays the preview of the screen.

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
When displaying a comment in HQ character, set [High Quality Font] for the comment 
group and set an even multiple of the text size.
If an odd multiple of the text size is set, the comment is not displayed in HQ character.

[Text Size]
Set the text size to be displayed.
➟1.2.5 Font specifications

[Text Color]

Set the text color.
➟6.4 Color Settings
The following shows the items to be selected.
• [Fixed]:

Displays comments only in the color set as a text color.
• [Comment Attribute]

Applies colors of comments according to the character attribute set for the comment 
group, and displays the comments.

[Alignment] Set the horizontal position of the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

4)

3)
8. OBJECT FUNCTION
8.12 Placing a Simple Alarm Display

8 - 437



3) [Comment Display Start Row]
When setting a comment involving multiple rows, set the row from which the comment is displayed.
Depending on the selection, the method of setting the row from which the comment is displayed varies.

• [Fixed]
Set by entering directly.
The setting range is [1] to [32767].

• [Device]:
Set the device value as the start row to be displayed.

➟6.1.2 How to set devices
If the comment is displayed in blank characters, check if the row from which the comment is display is set 
outside the range of the comment rows.

4) [Number of Comment Display Rows]
The item can be set only when [Single] is selected for [Number of Comments] in the [Device] tab.
When setting a comment involving multiple rows, set the number of the rows to be displayed.
Depending on the selection, the method of setting the number of the rows to be displayed varies.

• [Fixed]
Set by entering directly.
The setting range is [1] to [32767].

• [Device]:
Set the device value as the number of rows to be displayed.

➟6.1.2 How to set devices

■3 [Extended] tab

[Sort]

Select the type of the order in which alarms are displayed.
The following shows the items to be selected.
• [Ascending]
• [Descending]
• [Oldest]
• [Latest]
When the devices to be monitored are set randomly and [Ascending] or [Descending] is 
selected, alarms are displayed in the order in which the devices are set.

[Date Display (yy/mm/dd hh:mm:ss)]
Displays the date and time of the occurrences of alarms in the simple alarm display.
For the year, the lower 2 digits are displayed. The time is displayed in the 24-hour time 
format.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)

5) 6)
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1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

2) [User ID]
Select this item to set the user ID.
The setting range is [1] to [65535].
With the setting of user ID, the target ID (object) for an operation can be specified with a touch switch. Hence touch 
switch operations can be performed as required.
For secure operations of the touch switches for system alarm displays, set user ID.
To specify the user ID of the object to be operated with a touch switch, set [User ID for a key input] or [Individually 
set user ID for key input].
For touch switches, refer to the following.

➟8.2.4 [Switch] dialog
8.2.11 [Key Code Switch] dialog

3) [Comment No. Offset]
Comments displayed in the simple alarm can be switched with a single device value.
The device value set for this item is added to the comment number set for [Head Comment No.] of [Device].

➟6.1.11 Offset
4) [Comment No. Device]

Set a device that stores the comment number of an alarm.
Depending on the selection for [Number of Comments], the comment number assigned to the alarm to be stored in 
the device differs.

• If [Number of Comments] is [Multiple]
The comment number assigned to the alarm with which the cursor is displayed is stored.

• If [Number of Comments] is [Single]
The comment number assigned to the alarm on display is stored.

When displaying the cursor, make the following settings.
• Select [Selection] for [Touch Mode].
• Place the touch switches for the simple alarm display

➟8.2.4 [Switch] dialog
8.2.11 [Key Code Switch] dialog

5) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

6) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
8. OBJECT FUNCTION
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■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]
➟6.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)
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8.12.5 Relevant settings

Set the relevant settings other than the specific settings for the simple alarm display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT 
Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Notifying the key codes set to the input keys when the keys are input to text input, touch 
switch, or other objects (Write device) [Key Code Input]

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]
8. OBJECT FUNCTION
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8.13 Placing a System Alarm Display

With this function, error codes and error messages can be displayed when errors occur in the GOT, controllers, and 
networks.
The status an error causes and the cause of the error can be checked.
The registration of the comments to be displayed in the system alarm is not necessary. (They are registered in the GOT)

For details of alarms, refer to the following.
➟9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

8.13.1 Specifications of the system alarm display

■1 Maximum number of objects arrangeable on one screen
One system alarm display can be placed on one screen.

■2 Types of system alarms
There are the following three types of system alarms.

• CPU error
Indicates an error of a controller.

• GOT error
Indicates an error of the GOT.
A GOT Mobile error, which occurs on a GOT Mobile function client, is categorized as a GOT error.

• Network error
Indicates an error of the communication unit mounted on the GOT.

■3 How to collect data
The data of alarm status is always collected in the cycle of 3 seconds and retained in the GOT, even if a screen on which 
no system alarm is placed is displayed.

■4 Contents displayed in the system alarm
In the system alarm, error codes, error messages, and the time of occurrence are displayed.
The error codes and the error messages to be displayed are registered in the GOT as the default, so creating by a user 
is not necessary.

■5 Displaying the time of occurrences of alarms
For the time of occurrences, the clock data of the GOT is used.
For the precautions and restrictions of the clock function which manages the GOT clock data, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error
occurred

G01-400 The communication with 
               CPU failed.
M0101-9 AC down has been detected.
N21-803 The transient error has occurred.

16:40:30

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

16:40:30N21-803 The communication with CPU failed.
M0101-9 AC down has been detected.
G01-400 The transient error has occurred.

Error code Error message The time of the occurrence 
(displayed only for GOT errors)
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8.13.2 How to use the system alarm display

■1 Placing the system alarm display
Place the system alarm display on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing the system alarm display
Edit the system alarm display that has been placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Setting the system alarm display
Set the system alarm display that has been placed on the screen editor.
Common setting of objects

➟6.5.5 Common setting for objects
System alarm display settings

➟8.13.4 [System Alarm Display] dialog

■4 How to display alarms
(1) Maximum number of the alarms that can be displayed

The system alarm displays three types of alarms in different rows for each type, and up to three rows can be displayed.
When a new alarm is detected, the alarm display being displayed is updated.
Example) When a controller detects a new alarm (parameter error)

(2) Order of priority in which alarms are displayed
If the display range is two rows or less, alarms are displayed in the following order of priority.
1) GOT error
2) CPU error
3) Network error
When the number of the occurrences of alarms exceeds the display range, low-priority alarms cannot be displayed.
Also, an error code, error message, or time that cannot be displayed in one row of the display range is not displayed.

■5 How to adjust the display range
To set a display range in which alarm messages are fully displayed, adjust the range as shown below.
If the screen size of the GOT is smaller than the size with the following values, decrease the text size.

■6 Corrective actions on the cause of the alarm of each type and error codes
For details, refer to the following manuals.

➟The instruction manual of the GOT to be used

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The error display of controllers is updated. 
(M0101-9→M0101-104)

G01-400
M0101-9
N21-803

The communication with CPU failed.
AC down has been detected.
The transient error has occurred.

The communication with CPU failed.
A parameter error has occurred.
The transient error has occurred.

16:40:30 G01-400
M0101-104
N21-803

16:40:30

Set three rows for the display. 
(If the text size is 1 × 1, 48 dots are 
used for the vertical size in three rows.)

If the text size is 1 × 1, alarms are displayed with 576 dots. 
Enlarge the size until the time of occurrences on the right is displayed.

Error message (a maximum of 64 digits) The time of occurrences (fixed to eight digits)

The communication with CPU failed. 
AC down has been detected.
The transient error has occurred.

G01-400
M0101-9
N21-803

16:40:30
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8.13.3 Precautions for a system alarm display object

■1 Precautions for use
(1) Controllers for which system alarms are not displayed in the GOT

Errors which occur in the following controllers cannot be displayed in the system alarm of the GOT.
Check the errors with the software for the controllers.

• SIEMENS PLC CPU
• AZBIL equipment
• RKC temperature controller
• Inverter

(2) Deleting system alarms in the GOT
(a) How to delete the messages of GOT errors

GOT errors are not deleted from the system alarm even if the cause of the alarms is eliminated.
To delete the messages, turn on the following device for the system information function.

• GOT Error Reset signal (System signal 1-1.b13)
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

(b) How to delete the messages of network errors
The messages of network errors that occur in the CC-Link communication unit, MELSECNET/10 communication unit, 
and MELSECNET/H communication unit are not deleted even if the cause of the alarms is eliminated until the GOT is 
powered off or reset.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.13.4 [System Alarm Display] dialog

Step 1 Select [Object] → [Alarm Display] → [System Alarm Display] from the menu.
Step 2 Click the position to place a system alarm display.
Step 3 Double-click the system alarm display to display the setting dialog.

1) [Font]
Select the font of the displayed text.
The following shows the items to be selected.

• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23 only)

2) [Text Size]
Set the text size to be displayed.

➟1.2.5 Font specifications
3) [Text Color]

Set the text color.
➟6.4 Color Settings

4) [Shape Settings]

5) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

6) [Display detailed information on the target alarm]
Displays detailed information added to system alarms.

7) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

Item Description

[Shape]

Set a shape for an object.
When [None] is selected, no figure is displayed.
Click the [Shape] button to select shapes other than those in the list box.
➟6.5.5 ■1 Setting object shapes

[Frame Color], [Shape Color]

Select the color of the frame of the shape and shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

10)

8)

2)

9)

5)
6)
7)

3)

4)

Frame color
Shape color
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8) [Layer]
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

9) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
10) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

8.13.5 Relevant settings

Set the relevant settings other than the specific settings for the system alarm display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■3 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT Designer3
Always enabled.

[Adjust object display order in GOT to the one in GT 
Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Resetting system alarms and system information (GOT error code, GOT Error Detection 
signal) (Read device: System signal 1-1.b13) [System Signal 1-1]

Function Setting item

Storing the channel No. that has been assigned to the channel where a system alarm 
(GOT error) occurs
(Write device)

GS262

Storing the channel No. that has been assigned to the channel where a system alarm (CPU 
error) occurs
(Write device)

GS263

Storing the channel No. that has been assigned to the channel where a system alarm 
(network error) occurs
(Write device)

GS264
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8.14 Placing a Recipe Display (Record List)

The recipe display (record list) object lists the records of a recipe on the GOT.
You can perform the following manipulations on the records listed on the object by using applicable key code switches.

• Renaming a record
• Reading a record
• Writing a record
• Verifying a record
• Deleting a record

This object function must be used in combination with the recipe function.
For the details of the recipe function, refer to the following.

➟9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Record No. 1Device

D300

D301

D302

D303

Record No. 2 Record No. 3 Record No. 4

76

7

17

0

74

8

18

0

68

12

18

2

72

0

18

0

・ Recipe No. 1

The records of recipe 
No. 1 are listed.

Touch a record 
to select it.

Write record

Write a record to the PLC with 
an applicable key code switch.
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8.14.1 Specifications of the recipe display (record list)

The following shows the specifications of the recipe display (record list).

■1 System application (extended function)
To use the recipe display (record list), a system application (extended function) of [Recipe Display (Record List)] is 
required.
Placing the recipe display (record list) incorporates the application into the package data automatically.

➟8.14.4 [Recipe Display (Record List)] dialog
To use the function on GT SoftGOT2000, the application is not required.

■2 Maximum number of objects on one screen
One recipe display (record list) object can be placed on one screen.

■3 Maximum number of objects displayed at one time
One recipe display (record list) object can be displayed at one time.
Multiple recipe display (record list) objects cannot operate simultaneously.
When a recipe display (record list) object is displayed on the GOT, even if you call up a screen having another recipe 
display (record list) object, the object does not appear on the GOT.

■4 Maximum numbers of recipes and record rows displayed on the object
The records of one recipe can be displayed on the recipe display (record list) object.
When the recipe number is specified using a device value, switching between recipes is available.
Up to 64 record rows can be displayed on the object.

■5 Key code switch
The recipe display (record list) is operable using key code switches. 
Place the following key code switches on the screen as necessary.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Key code Operation Description

FFF0h Show cursor Display the cursor on a record row to select the row.

FFF1h Hide cursor Hide the cursor.

FFEFh Update list Update the list.

FFF4h List Displacement Scroll Up Scroll the list up the specified number of rows.

FFF5h List Displacement Scroll Down Scroll the list down the specified number of rows.

FFF6h List Page Scroll Up Scroll the list up one page.

FFF7h List Page Scroll Down Scroll the list down one page.

FFF2h Move cursor upward Move the cursor up one row.

FFF3h Move cursor downward Move the cursor down one row.

FFCAh Rename record Rename a record.

FFCBh Save record Read a record from the PLC.

FFCCh Load record Write a record to the PLC.

FFCDh Verify record Verify the device values of a record against those of the PLC.

FFB6h Delete record Delete a record.

FFCEh Cancel recipe operation Cancel the reading, writing, or verifying of a record.
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8.14.2 How to use the recipe display (record list)

■1 Setting the recipe function
To use the recipe display (record list), the recipe function must be set.

➟9.3.3 How to use the recipe

■2 Placing a recipe display (record list)
The following shows the procedure for setting a recipe display (record list).

Step 1 Place a recipe display (record list) on the screen editor.

➟6.5.1 Placing figures and objects
Step 2 Upon placement of the recipe display (record list), key code switches are also placed.

The user ID of the recipe display (record list) is assigned to each key code switch.
Optionally delete unnecessary key code switches and place the necessary ones.

➟8.2.11 [Key Code Switch] dialog
Step 3 Configure the settings of the recipe display (record list).

➟8.14.4 [Recipe Display (Record List)] dialog
For the settings common to the objects, refer to the following.

➟6.5.5 Common setting for objects

■3 Operating a recipe display (record list)
The following shows how to operate a recipe display (record list).

(1) List layout
The following shows the list layout of the recipe display (record list).

1) [No.]
Displays the record numbers.

2) [Record Name]
Displays the record names.
If the name of a record is unspecified, the relevant cell is left blank.

3) [Date of Update]
Displays the update date and time of each record.
If a record is not read from the PLC, a hyphen [-] is displayed.

4) [Attribute]
Displays the record attributes that indicate whether each record is readable or writable.
V: The record can be written to a PLC.
P: The record cannot be overwritten with the data read from a PLC. (Overwriting prohibited record)
VP: The record can be written to a PLC, but cannot be overwritten with the data read from a PLC.
-: The devices of the record store no values, and the record can be overwritten with the data read from a PLC.

5) Title row
Displays the column headers.
Touch a column header to sort the record list in ascending or descending order based on the column.

6) Record rows
Each row displays one record.
Touch a record row to select the record, and touch the row again to deselect the record.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4)

5)

6)
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(2) Moving a recipe display (record list) object with a slide operation
You can slide your finger on a recipe display (record list) object to move the object without using the object gesture 
function.

(3) Reading, writing, or deleting a record
You can read, write, or delete a record selected on the recipe display (record list).
To perform these operations, use applicable key code switches.
Place the following key code switches in advance.

• FFCBh: Read record
• FFCCh: Write record
• FFB6h: Delete record
Step 1 Touch a target record on the recipe display (record list) to select it.
Step 2 Touch an applicable key code switch to write, read, or delete the selected record.

You can specify the name of the target record by using specific devices. To do this, enable the setting for the Control 
Target Record Name devices.
For the details of the Control Target Record Name devices, refer to the following.

➟8.14.2 ■4 (1) Specifying the name of a manipulation target record by using specific devices

(4) Renaming a record
You can rename a record selected on the recipe display (record list).
Up to 32 ASCII or Unicode characters are usable for a record name.
To specify a new record name, use the Control Target Record Name devices.
Set the Control Target Record Name devices in advance.

➟8.14.4 ■5 [Extended] tab
8.14.2 ■4 (1) Specifying the name of a manipulation target record by using specific devices

To perform the rename operation, use an applicable key code switch.
Place the following key code switch in advance.

• FFCAh: Change record name
Step 1 Touch a target record on the recipe display (record list) to select it.
Step 2 Touch the applicable key code switch to rename the selected record.

Delete record
(FFB6h)

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

1.

2.

Read record
(FFCBh)

Write record
(FFCCh)
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(5) Verifying a record
You can verify the device values of a record selected on the recipe display (record list) against those of the PLC.
To perform verification, use an applicable key code switch.
Place the following key code switch in advance.

• FFCDh: Verify record
• FFCDh: Verify record
Step 1 Touch a target record on the recipe display (record list) to select it.
Step 2 Touch an applicable key code switch to verify the device values of the selected record against those of the 

PLC.
The verification results are shown in a dialog.

You can specify the name of the target record by using specific devices. To do this, enable the setting for the Control 
Target Record Name devices.
For the details of the Control Target Record Name devices, refer to the following.

➟8.14.2 ■4 (1) Specifying the name of a manipulation target record by using specific devices

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product E

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Change record name
(FFCAh)

1.

2.

Control Target Record Name devices: D500 to D531
Stored character string: Product E

The record is renamed from 
"Product B" to "Product E".

Change record name
(FFCAh)

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

1.

2.

Verify record
(FFCDh)

Verify record
(FFCDh)

The registered value is the same 
as the current value.

O　K

Record No. 2
D100 = 500
D150 = 250
D200 = 100

D100 = 500
D150 = 250
D200 = 100

Verify
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■4 Notification and control by using specific devices
The following shows how to make notification or exercise control relevant to the recipe display (record list) by using 
specific devices.

(1) Specifying the name of a manipulation target record by using specific devices
To use specific devices to specify the name of a record targeted for manipulation with key code switches, enable the 
setting for the Control Target Record Name devices.
The record whose name is specified using the Control Target Record Name devices always becomes the manipulation 
target even if another record is selected on the recipe display (record list).

To specify the Control Target Record Name devices, set [Control target record name] on the [Extended] tab in the [Recipe 
Display (Record List)] dialog.

➟　 8.14.4 ■5 [Extended] tab
You can specify a word device or word-specified bit device.
Specify the target record name within 32 ASCII or Unicode characters.
For storing ASCII characters as the record name, the number of consecutive devices to be used is half of the maximum 
number of characters set for [Control target record name].
For storing Unicode characters as the record name, the number of consecutive devices to be used equals to the 
maximum number of characters set for [Control target record name].

(a) Reading a record
The GOT reads the device values from the PLC to a target record when the applicable key code switch is touched. The 
character string stored in the Control Target Record Name devices is compared with the names of records in the target 
recipe. Consequently, the GOT reads the device values from the PLC to the record that has the exact match name.
If multiple records have the exact match name, the GOT reads the device values from the PLC to the lowest numbered 
record.
If no record has the exact match name, the GOT reads the device values from the PLC to the lowest numbered blank 
record (that has no name and device value).
In this case, the record is named with the character string stored in the Control Target Record Name devices.
If the Control Target Record Name devices store no character string, the GOT reads the device values from the PLC to 
the record selected on the recipe display (record list).
If no record is selected, the GOT does not perform record reading.

(b) Writing a record
The GOT writes the device values of a target record to the PLC when the applicable key code switch is touched. The 
character string stored in the Control Target Record Name devices is compared with the names of records in the target 
recipe. Consequently, the GOT writes the device values to the PLC from the record that has the exact match name.
If multiple records have the exact match name, the GOT writes the device values to the PLC from the lowest numbered 
record.
If the record selected on the recipe display (record list) has the exact match name, the GOT writes the device values to 
the PLC from the selected record.
If no record has the exact match name, the GOT does not perform record writing.
If the Control Target Record Name devices store no character string, the GOT writes the device values to the PLC from 
the record selected on the recipe display (record list).
If no record is selected, the GOT does not perform record writing.

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

2015/12/25 11:45

2014/08/02 09:25

Product A 2016/04/25 10:25

V
VP

V

Control Target Record Name devices: D500 to D531
Stored character string: Product D

Read record
(FFCBh)

The record named 
"Product D" is read.

Example) Reading a record

Selected
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(c) Verifying a record
The GOT verifies the device values of a target record against those of the PLC when the applicable key code switch is 
touched. The character string stored in the Control Target Record Name devices is compared with the names of records 
in the target recipe. Consequently, the GOT verifies the device values of the record that has the exact match name.
If multiple records have the exact match name, the GOT verifies the device values of the lowest numbered record.
If the record selected on the recipe display (record list) has the exact match name, the GOT verifies the device values of 
the selected record.
If no record has the exact match name, the GOT does not perform record verification.
If the Control Target Record Name devices store no character string, the GOT verifies the device values of the record 
selected on the recipe display (record list).
If no record is selected, the GOT does not perform record verification.

(d) Deleting a record
The GOT deletes the contents of a target record when the applicable key code switch is touched. The character string 
stored in the Control Target Record Name devices is compared with the names of records in the target recipe. 
Consequently, the GOT deletes the contents of the record that has the exact match name.
If multiple records have the exact match name, the GOT deletes the contents of the lowest numbered record.
If the record selected on the recipe display (record list) has the exact match name, the GOT deletes the contents of the 
selected record.
If no record has the exact match name, the GOT does not perform record deletion.
If the Control Target Record Name devices store no character string, the GOT deletes the contents of the record selected 
on the recipe display (record list).
If no record is selected, the GOT does not perform record deletion.

(e) Renaming a record
The GOT renames the record selected on the recipe display (record list) when the applicable key code switch is touched. 
The record is renamed with the character string stored in the Control Target Record Name devices.
The record rename is not performed in the following cases.

• The Control Target Record Name devices are not set.
• The Control Target Record Name devices store no character string.

(2) Narrowing down the records to be displayed
To narrow down the records to be displayed on the recipe display (record list) by specifying a character string included 
in the record names, enable the setting for the Narrow Down Record Names devices.

To specify the Narrow Down Record Names devices, set [Narrow down record names] on the [Extended] tab in the 
[Recipe Display (Record List)] dialog.

➟8.14.4 ■5 [Extended] tab
You can specify a word device or word-specified bit device.
Specify the character string (narrowing criteria) within 32 ASCII or Unicode characters.
For storing ASCII characters as the narrowing criteria, the number of consecutive devices to be used is half of the 
maximum number of characters set for [Narrow down record names].
For storing Unicode characters as the narrowing criteria, the number of consecutive devices to be used equals the 
maximum number of characters set for [Narrow down record names].

No. Date of UpdateRecord Name Attribute

1 VPBolt M3 -

3 Flange Bolt M3 - VP

Bolt M8
Flange Bolt M8

- VP

- VP

5

7

Narrow Down Record Names devices: D600 to D631
Stored character string: Bolt

Example

Recipe display (record list)
No. Date of UpdateRecord Name Attribute

1 VP
2 Nut M3 -

Bolt M3 -
VP

3 Flange Bolt M3 - VP

4 Flange Nut M3

Nut M8
Bolt M8

Flange Bolt M8
Flange Nut M3

- VP
- VP

- VP
- VP

- VP

5
6
7
8

Recipe display (record list)

The object lists the record names that 
include the character string specified using 
the Narrow Down Record Names devices.
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(3) Notifying the selected record name
To notify the name of a record selected on the recipe display (record list), enable the setting for the Cursor Row Record 
Name devices.
The Cursor Row Record Name devices store the name of a record selected on the recipe display (record list).
If you deselect the selected record on the recipe display (record list), the values of the Cursor Row Record Name devices 
are cleared.
To specify the Cursor Row Record Name devices, set [Cursor row record name] on the [Extended] tab in the [Recipe 
Display (Record List)] dialog.

➟8.14.4 ■5 [Extended] tab
You can specify a word device or word-specified bit device.
The record name is notified within 32 ASCII or Unicode characters.

• For the record name using ASCII characters
The number of consecutive devices to be used is half of the maximum number of characters set for [Cursor row 
record name].
If the number of the stored characters is less than the maximum number of characters, the stored characters are 
padded with NULL characters.
If the consecutive devices store an odd number of characters from lower-order bytes, 0 is stored in the higher-order 
bytes of the device that stores the last character.
If the consecutive devices store an odd number of characters from higher-order bytes, 0 is stored in the lower-order 
bytes of the device that stores the last character.

• For the record name using Unicode characters
The number of consecutive devices to be used equals the maximum number of characters set for [Cursor row record 
name].
If the number of the stored characters is less than the maximum number of characters, the stored characters are 
padded with NULL characters.

(4) Notifying the record manipulation status
To notify the execution status of the manipulation performed on the recipe display (record list), enable the setting for the 
Notify Recipe Status device.
The Notify Recipe Status device notifies the execution status as shown below.

To specify the Notify Recipe Status device, set [Notify the recipe status] on the [Extended] tab in the [Recipe Display 
(Record List)] dialog.

➟8.14.4 ■5 [Extended] tab
You can specify a signed 16-bit binary word device or word-specified bit device.

(5) Notifying the number of displayable records
To notify the number of records displayable on the recipe display (record list), enable the setting for the Number of 
Currently Displayed Records device.
To specify the Number of Currently Displayed Records device, set [Number of currently displayed records] on the 
[Extended] tab in the [Recipe Display (Record List)] dialog.

➟8.14.4 ■5 [Extended] tab
You can specify a signed 16-bit binary word device or word-specified bit device.

Bit number Description

b0 Turns on when the GOT writes a record to the PLC by using the recipe display (record list).
Turns off after the record writing is complete.

b1 Turns on when the GOT reads a record from the PLC by using the recipe display (record list).
Turns off after the record reading is complete.

b2
Turns on when the GOT verifies the device values of a record selected on the recipe display 
(record list) against those of the PLC.
Turns off after the record verification is complete.

b3 Turns on when the GOT acquires the records to be displayed on the recipe display (record list).
Turns off after the record acquisition is complete.

b4 to b15 Use prohibited
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8.14.3 Precautions for a recipe display (record list) object

The following shows the precautions for the recipe display (record list).

■1 Precautions for drawing
(1) User ID assigned to the key code switches

Upon placement of the recipe display (record list) on the screen editor, key code switches are also placed.
The user ID of the recipe display (record list) is automatically assigned to each key code switch ([User ID for a key input]).
If you change the user ID of the recipe display (record list), also change the set value of [User ID for a key input] for each 
switch.
Otherwise, the recipe display (record list) is inoperable using the switches.

➟8.2.11 [Key Code Switch] dialog

(2) Record used for record reading
When you use the Control Target Record Name devices to read a record, preset a blank record that has no name and 
device value.
If the record specified with the Control Target Record Name devices is nonexistent, the read data is written to the blank 
record.
If a blank record is nonexistent, a system alarm occurs in the above case.
Moreover, the number of records in the recipe is unchangeable on the GOT.
However, if you preset several blank records, you can write the read data to the blank records on the GOT.

➟9.3.3 How to use the recipe

(3) Precautions for placing a recipe display (record list) by operation in the [Recipe] dialog
If you place a recipe display (record list) by using the [Create a new recipe display (record list)] button in the [Recipe] 
dialog, the settings of the following items in the [Options] dialog are not applied.

• Place figures/objects sequentially
• Deselect figures/objects once they are placed
• Display the setting dialog once figures/objects are placed

➟9.3.7 [Recipe] dialog
11.10.4 Customizing the settings related to editing operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Blank record with no name and device value

D300

D301

D302

D303

76

7

17

0

74

8

18

0

Record No. 1 Record No. 2 Record No. 3 Record No. 4Device

・ Recipe No. 1

Product A Product B

Record No.

Record name
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■2 Precautions for use
(1) Changing the values of the Control Target Record Name devices

When the record name selected on the recipe display (record list) differs from the one specified using the Control Target 
Record Name devices, the latter is always targeted for manipulation using the key code switches.
To manipulate a record selected on the recipe display (record list), clear the values of the Control Target Record Name 
devices first.

Example) When reading a record

(2) Precautions while the recipe operation window is being displayed
While the recipe operation window is being displayed, the recipe display (record list) is inoperable and displayed 
incorrectly.
Close the recipe operation window, and then operate the recipe display (record list).

(3) Precautions for specifying a record name with Control Target Record Name devices
You cannot specify a record name ending with a one-byte space by using Control Target Record Name devices. (The 
one-byte space is deleted.)
When you set a record name in the [Recipe] dialog on GT Designer3 or the recipe operation window on the GOT, do not 
append a one-byte space to the record name.

(4) Precautions for using the Recipe Display (Record List) Record Manipulation Result (GS1016)
If you manipulate a record while GS1016 is on, you cannot distinguish between the previous and current manipulation 
results.
Before manipulation, turn on the Recipe Display (Record List) Control device (GS1809.b15) to turn off GS1016.

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Record No. Date of UpdateRecord Name Attribute

1

2016/04/25 10:00Product B

P

2

3
4

Product C

Product D

-

2014/08/02 09:25

Product A -

V
VP

V

Selected
Read record

(FFCBh)

Even though another record is 
selected, the record named 
"Product D" is read.

Read record
(FFCBh)

Use a text input object, and input a character string "Product D" 
to the Control Target Record Name devices.

"Product D"

Product D

Product D
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8.14.4 [Recipe Display (Record List)] dialog

Step 1 Select [Object] → [Recipe Display (Record List)] from the menu.
Step 2 Click the position to place a recipe display (record list).
Step 3 Double-click the recipe display (record list) to display the setting dialog.

➟■1 [Recipe Setting] tab
■2 [Display] tab
■3 [Text] tab
■4 [Style] tab
■5 [Extended] tab
■6 [Trigger] tab

■1 [Recipe Setting] tab

1) [Recipe No.]
Set the method of specifying a recipe number to display records on the recipe display (record list).

2) [Number of Display Rows]
Set the maximum number of record rows to be displayed.
The setting range is [1] row to [64] rows.

3) [Display Target]
Select the records targeted for display.

• [All records]: Displays all records of a recipe.
• [Writable records]: Displays the writable records of a recipe.
• [Readable records]: Displays the readable records of a recipe.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Fixed]
Displays the records of a recipe with a fixed recipe number.
Select this item and enter a recipe number.
The setting range is [1] to [32767].

[Device]
Displays the records of a recipe whose recipe number is specified with a device value. Select 
this item and set a device.
➟6.1.2 How to set devices

[Recipe No. to be displayed when device value 
is 0]

When selecting [Device] for [Recipe No.], set this item.
Specify a recipe number to display target records when the set device stores 0.
The setting range is [1] to [32767].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
4)

5)

6)

7)
8)
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4) [Display Order]
Set the order in which records are displayed for the first time.
The selectable sort criteria are [Record No.], [Record Name], [Date of Update], and [Attribute].
The selectable sort orders are [Ascending] and [Descending].

5) [Preset Selection]
Select the design of the recipe display (record list).
Click the pull-down menu button to display all designs.

6) [Font]
Select a font of the displayed text.
The following shows the items to be selected.

• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

7) [Text Size]
For the details of each font and size, refer to the following.

➟1.2.5 Font specifications
8) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Sort criterion Sort order

Pull-down menu button
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■2 [Display] tab

1) [Title]

2) [Display Order]
Set the order in which the columns of [Display Items] are displayed.
Click the right or left arrow button to move the selected column.

Item Description

[Specification]

Select the method of specifying the text to be displayed in the title.
The following shows selectable items.
• [Direct]:

Select this item to input the text to be displayed in the title directly into [Title] in [Contents].
• [Comment]:

Select this item to display the text to be displayed in the title using the comment in the 
comment group.

• [None]:
Select this item not to display the title.

[Group No.] Only when [Comment] is selected for [Specification], this item can be set.
Set the comment group in which the text to be displayed in the title is registered.

[Adjust Text Size] The text size is adjusted according to the width of the title.
When [Adjust Text Size] is not selected, the text size is adjusted by inserting a line feed.

[Minimum Size]

Only when [Comment] is selected for [Specification] and [Adjust Text Size] is selected,this 
item can be set.
Set the minimum text size for adjustment.
The setting range is [8] to [240] dot(s).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

4)

1)

3)
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3) [Display Items] button
Displays the [Display Items] dialog.
Select an item to be displayed on the recipe display (record list).

4) [Display Items]
Set the details of the display items.

• [Record No.]
Lists the record numbers.

• [Record Name]
Lists the record names.

• [Date of Update]
Lists the update date and time of each record.

• [Attribute]
Displays the record attributes that indicate whether each record is 
readable or writable.

Item Description

[Digits] Set the number of digits to be displayed in each column.
The setting range is [1] digit to [128] digits.

[Title]

[Title Text] Set the column headers to be displayed in the title row.
This setting depends on the selection for [Specification].
• [Direct]

Enter text directly. The number of the characters must be within the set value of [Digits].
• [Comment]

Set a comment No. or comment.
• [None]

Not settable

[Alignment] Select the horizontal position to align the text to be displayed in the title row. The following 
shows the items to be selected.
• [Left]
• [Center]
• [Right]

[Data]

[Display Setting] Set the display format of the update date and time.
Click the [...] button to set the date and time format in the [Date/Time Setting] dialog.
➟6.3.2 Date/time format settings

[Alignment] Select the horizontal position to align the text to be displayed in the record rows.
The following shows the items to be selected.
• [Left]
• [Center]
• [Right]

Right button
Left button

Selected item

Move to the left.

Click the right button.

Click the left button.

Moves to the right.
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■3 [Text] tab

1) [Title Format]
Set the format of the title row.

Item Description

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4.2 Color settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

➟6.4.2 Color settings

[Background Color] Set the background color of the title row.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

[Solid] button
[Raised] button

[Bold] button
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2) [Record Row Format]
Set the format of the record rows.

3) [Cursor Row Format]
Set the format of the selected row.

Item Description

[Text Color]

Set the color and style of the text to be displayed in the record rows.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4.2 Color settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

➟6.4.2 Color settings

[Background Color] Set the background color of the record rows.

[Change colors alternately]
Set [Text Color] and [Background Color] for the even-numbered record rows.
➟6.4.2 Color settings

Item Description

[Text Color]
Set the color of the text to be displayed in the selected row.
➟6.4.2 Color settings

[Background Color]
Set the background color of the selected row.
➟6.4.2 Color settings

[Solid] button
[Raised] button

[Bold] button
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■4 [Style] tab

1) [Borders]

Item Description

[Display]

Displays a border in the selected position.
The following shows display items.
• [Frame (T/B)]
• [Frame (L/R)]
• [Title Underline]
• [Column]
• [Row]

[Line Style]

Select the style of ruled lines.
The following shows the items to be selected.
• Straight line
• Fine broken line
• Coarse broken line
• Speck chain line
• Two-dot long and two short dashes line

[Line Width]

Set the ruled line color.
The following shows the items to be selected.
• [1Dot]
• [2Dot]
• [3Dot]
• [4Dot]
• [5Dot]
• [7Dot]

[Line Color]
Select the color of the frame.

➟6.4.2 Color settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

3)

1)

2)

4)
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2) [Space]
Set the space between the text to be displayed and the ruled lines of the table.
The setting range is [0] to [32].
The following illustrates the space [X] and [Y].

3) [Shape Setting]

4) [Scrolling Increment]
Set the number of rows to be scrolled in the recipe display (record list) when an arrow key on the scroll bar or a key 
code switch (FFF4h or FFF5h) is touched.
The setting range is [1] row to [64] rows.

5) [Display the scroll bar]
Displays the scroll bar.

Item Description

[Shape]
Select the shape to be set for the object from the list or with the [Shape] button.

➟6.5.5 ■1 Setting object shapes

[Frame Color]
Select the frame color of the shape.

➟6.4.2 Color settings

[Shape Color]
Select the color of the shape.

➟6.4.2 Color settings

Item Description

[Width]

Specify the width of the scroll bar.
The up or down button on the scroll bar is a square.
Accordingly, the width and height of the button equal the width of the scroll bar.
The setting range is [16] dots to [64] dots.

[Color]
Set the color of the scroll bar.

➟6.4.2 Color settings

[Background Color]
Set the background color of the scroll bar.

➟6.4.2 Color settings

No. Date of UpdateRecord Name Attribute

1 V

2

Product A 2016/04/25 10:25

Space (X)

Space (Y)

Product B 2016/04/25 10:25 V

No.
1

2016/04/25 10:00

P

2

2016/04/25 10:25

V

Date of UpdateRecord Name Attribute

Product A
Product B

Height of the up and down buttons
(equal to the width of the scroll bar)

Width of the scroll bar
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■5 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].
The value of [Operation] must be greater than the value of [Display].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].
The following operations can be performed when user ID numbers are set.

• Identifying the object that is operated with a key code switch
➟8.2.11 [Key Code Switch] dialog

• Setting the position where the cursor is displayed at screen switching
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

• Identifying the object that is targeted for the operation log function
➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])

3) [Operation Log Target]
Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
4) Setting the devices for control and notification

Set the control and notification devices for the recipe display (record list).

Item Description

[Item]

Select necessary items for control or notification.
• [Control target record name]

Enables the setting for the Control Target Record Name devices.
➟8.14.2 ■4 (1) Specifying the name of a manipulation target record by using specific devices

• [Narrow down record names]
Enables the setting for the Narrow Down Record Names devices.
➟8.14.2 ■4 (2) Narrowing down the records to be displayed

• [Cursor row record name]
Enables the setting for the Cursor Row Record Name devices.
➟8.14.2 ■4 (3) Notifying the selected record name

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

6)

4)

1)

2)
3)

5)

7)
8)
9)
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5) [Notify the recipe status]
Enables the setting for the Notify Recipe Status device.

➟8.14.2 ■4 (4) Notifying the record manipulation status
Select this item and specify the Notify Recipe Status device.

➟6.1.2 How to set devices
6) [Number of currently displayed records]

Enables the setting for the Number of Currently Displayed Records device.
➟8.14.2 ■4 (5) Notifying the number of displayable records

Select this item and specify the Number of Currently Displayed Records device.
➟6.1.2 How to set devices

7) [KANJI region]
Select the KANJI region of the displayed text.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

8) [Layer]
Not available to GT21 and GS21.
Switches layers to be placed.
The following shows the items to be selected.

• [Front]
• [Back]

9) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

[Device]

Set the first device of consecutive devices to be used for control or notification.
You can specify a word device or word-specified bit device.
The number of the consecutive devices varies with the settings of [Character Count] and [Character 
Code].
When [Character Code] is set to [ASCII], the number of the consecutive devices equals half of the set 
value of [Character Count].
When [Character Code] is set to [Unicode], the number of the consecutive devices equals the set value 
of [Character Count].

➟6.1.2 How to set devices

[Character Count]
Set the maximum number of characters to be stored in the devices for control or notification.
The setting range is [1] to [32].

[Character Code]

Select the character code of the character string to be stored in the devices for control.
The following shows the items to be selected.
• [ASCII]
• [Unicode]

[Storage Order]

Select the order in which character codes are stored.
The following shows the items to be selected.
• [Low-->High]
• [High-->Low]

Item Description
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■6 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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8.14.5 Relevant settings

Set the relevant settings other than the specific settings for the recipe display (record list) as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■3 GOT Internal Device
➟12.1.3 GOT special register (GS)

*1 For information on how to link the recipe function with the recipe display (record list) by using GS1013 and GS1014, refer 
to the following.

➟9.3.3 ■9 Link with the recipe display (record list) by using GOT special registers

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Notifying that the recipe process (reading or writing) is being executed (Write device: System signal 2-
1.b10) [System Signal 2-1]

Function Setting item

Notifying the recipe number for the records displayed on the recipe display (record list) *1

(Write device)
GS1013

Notifying the record number selected on the recipe display (record list) *1

(Write device)
GS1014

Storing the record number of the manipulated record while GS1809.b0 is on.
(Write device)

GS1015

Notifying the record manipulation result while GS1809.b0 is on.
(Write device)

GS1016.b0 to GS1016.b2
GS1016.b11 to GS1016.b15

Displaying no confirmation or notification dialog during a record manipulation.
(Read device)

GS1809.b0

Clearing the record manipulation result that has been notified by GS1016.
(Read device)

GS1809.b15
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8.15 Placing a Line Graph

This function collects multiple word device values in a batch and displays the values in a line graph.

Application example) Displaying the production quantity of multiple lines

8.15.1 Specifications of the line graph

The following shows the specifications of the line graph.

■1 Number of line graphs that can be set
(1) Number of line graphs that can be placed

Up to 32 line graphs can be placed on one screen.

(2) Number of lines that can be displayed
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to eight lines can be displayed in one line graph.
• For GT21 and GS21

Up to four lines can be displayed in one line graph.

(3) Number of settable points
Up to 500 points can be set on one line.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

400

200

  0
21 3 4

D10 = 100
D11 = 50
D12 = 200
D13 = 150

400

200

  0
21 3 4

D10 = 150
D11 = 100
D12 = 250
D13 = 350

Scale value
 Y: Indicates the achievement rate.
 X: Indicates the line numbers in which 
     the production quantity is monitored.

Lower limit value, upper limit value
Set the production quantity.

100

0

50

1 5

6000

0 32 4

Production quantity for each line (1 to 5)
(D10 to 14)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.15.2 How to use the line graph

The following shows how to use the line graph.

■1 Placing the line graph
The following shows how to place the line graph.

Step 1 Select [Object] → [Graph] → [Line Graph] from the menu.
Step 2 Click the position where you place the line graph. Placing the line graph is complete.
Step 3 Adjust the frame size of the line graph.
Step 4 Double-click the placed line graph to display the setting dialog.

➟8.15.4 [Line Graph] dialog
Step 5 Display the [Data] tab.

➟8.15.4 ■1 [Data] tab
Step 6 Set the number of lines and points.

Step 7 Set a device to be monitored.

➟6.1.2 How to set devices
Step 8 Set [Lower Limit] and [Upper Limit].
Step 9 Set the scale and figure in the [Style] tab.

➟8.15.4 ■2 [Style] tab

Step 10 Click the [OK] button to complete the line graph settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display direction (right)

Lower limit, upper limit
(lower limit: 0, upper limit: 6000)

6000

0

Number of lines (1 line)

Number of points (5)

Monitored device
(D10, D11, D12, D13, D14)

6000

0
0

50

0 1005025 75

Scale
 Y (number of lines: 5)
 X (number of points: 5)

Scale value
 Y: (lower limit: 0, upper limit: 50)
 X: (lower limit: 0, upper limit: 100)

25

Figure
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■2 Setting [Collect data only when trigger conditions are satisfied]
Not available to GT21 and GS21.
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.

Step 1 Select [Object] → [Graph] → [Line Graph] from the menu.
Step 2 Click the position where you place the line graph. Placing the line graph is complete.
Step 3 Double-click the placed line graph to display the setting dialog.

➟8.15.4 [Line Graph] dialog
Step 4 Display the [Trigger] tab.

➟8.15.4 ■4 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].
Step 6 Set [Collect data only when trigger conditions are satisfied].

Example) Combining the line graph and trend graph

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

54321
0

50

100

54321
0

50

100

   

Trigger type       : Sampling (3 seconds)
Collect data only when 
trigger conditions are satisfied  : Disabled
Object       : Trend graph

Communicates in the set cycle and 
refreshes the display frequently.

54321
0

50

100

Trigger type       : Rise
Collect data only when 
trigger conditions are satisfied  : Enabled
Object       : Line graph

Displays the graph (communicates) 
only at startup.

The line graph can be used as 
the reference value and compared 
with the trend graph.
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8.15.3 Precautions for a line graph

This section explains the precautions for the line graph.

■1 When the monitored device value exceeds the upper or lower limit value
When the monitored device value exceeds the lower limit value, the display of the lower limit value is applied.
When the monitored device value exceeds the upper limit value, the display of the upper limit value is applied.

■2 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

Not available to GT21 and GS21.

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the line graph is refreshed at timing 1).
• The display of the line graph is refreshed at timing 2).
• At timing 3), the display of the line graph is not refreshed because the timing does not match the end of one cycle 

and thus the condition is not checked.
• At timing 4), the display of the line graph is not refreshed because the device condition is not satisfied.
• The display of the line graph is refreshed at timing 5).

(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

(2) Refresh timing when [Sampling], [ON Sampling], or [OFF Sampling] is selected
The sampling cycle count starts and is reset at the following timing.

• When the line graph is displayed (in screen switching, a security level change, or other possible cases)
• When the language switches
• When the security level changes

After the execution of any of the events, the display is refreshed at the start timing of the sampling cycle.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10: 7000Upper limit 
value: 6000

Lower limit 
value: 0

D10: -1000

OFF

Sampling cycle set for 
[Trigger Type]

1 second 1 second 1 second

Device status set for 
[Device]

1) 2)

3)

4) 5)

ON
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8.15.4 [Line Graph] dialog

The line graph is an object that collects multiple word device values in a batch and displays the values in a graph.
Step 1 Select [Object] → [Graph] → [Line Graph] from the menu.
Step 2 Click the position where you place the line graph. Placing the line graph is complete.
Step 3 Double-click the placed line graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Data] tab

Set the device to be monitored and the line graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Line Graph]
• [Bar Graph]

Select [Line Graph] in this section.
2) [Number of Pens]

Set the number of lines to be displayed.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [8].

• For GT21 and GS21
The setting range is [1] to [4].

3) [Points]
Set the number of points to be displayed on a line (the number of devices to be monitored).
The setting range is [2] to [500].
Depending on the number of points and X-axis display range, the interval between points is adjusted automatically.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

5)

7)

2)

6)

3)
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4) [Direction]
Select the display direction of the graph.
The following shows the items to be selected.

• [Right]
• [Left]

5) [Device]

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

Point interval = 20 dots

Example)
Number of points: 5

X-axis 100 dots

Set placement 
direction of the 
devices

Device value 
to be monitored

Device value 
to be monitored

D1 D2 D3 D4 D5 D6 D6 D5 D4 D3 D2 D1

• Right

Set placement 
direction of the 
devices

• Left
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[Device]

Click the [Edit] button to display the [Edit Device] dialog.

• [Device Setting]
Select how to set the device.
The following shows the items to be selected.
• [Continuous]

When a start device is set, inputs consecutive devices automatically in the table of 
[Device].

• [Random]
Not available to GT21 and GS21.
Select this item when setting devices one by one.

• [2 Device/point]
Not available to GT21 and GS21.
Select this item when displaying two device values (placed on the vertical axis) on one 
point (placed on the horizontal axis).
If this item is set, [Step Mode] cannot be set.

➟6.1.2 How to set devices

[Graph] Select the color of the line.

[Line Style]

Select the style of the line.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

[Width]

Select the width of the line.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Step Mode]

Select this item to display the line by steps.

If this item is set, [2 Device/point] cannot be set.

Item Description

Device list

1 device/point 2 devices/point

Display two 
devices on 
one point.

Displayed by no steps Displayed by steps
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6) [Lower Limit] and [Upper Limit]
Select whether to specify the display range (lower and upper limit values) of the line graph with the fixed value or 
with the device value.
The following shows the items to be selected.

• [Fixed]:
Specify a constant.

• [Device]:
Specify a device value.

➟6.1.2 How to set devices
The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].

7) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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1) [Shape]

2) [Scale Settings]
Displays the line or scale value in the line graph.

Item Description

[Shape]

Set the shape of the line graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.4 ■1 Lamp attribute setting
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

Item Description

[Scale]

Set this item to display lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [101].

• [Color]
Set the color of lines on the scale.

Preview

[Frame Color]

[Shape Color]

Line
(X: 5)
(Y: 5)

Scale value
(X: 3)
(Y: 3)

Displays both the lines 
and scale values.

100

500 100

50

0
500 100

100

50

0
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[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value] ([Horizontal] and [Vertical])
Set the number of numeric characters.
The setting range is [0] and [2] to [101].

• [Lower Limit] ([Horizontal] and [Vertical]) and [Upper Limit] ([Horizontal] and 
[Vertical])
Set the lower limit and upper limit of the numerical value.
Changes in this setting are automatically applied to the display.

Depending on the item selected for [Data Type] in the [Data] tab, the setting range is 
different.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

[Display the graph frame]

Select this item to display the frame of the graph.

Item Description

[Upper Limit]

[Lower Limit]

Automatically 
changed.

Change the scale value of Y
Upper limit value: 100 → 500

100

50
0

500

250

100

50

0 50
0

1000

Graph frame
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Hidden Value]

Select this item not to connect a specified device value with other values with the line during monitoring.
After selecting this item, set the device value.

4) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

5) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)

4)

5)

200
100

0

300
200
100

0

300 300

0 1 2 3 40 1 2 3 4

When [300] is set 
for [Hidden Value]

When [Hidden Value] 
is not selected
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■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
3) [Settings]

For details of each item, refer to the following.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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➟6.2.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Not available to GT21 and GS21.
Set the expression used for the script function.

➟(2) [Script]

Item Description

[Collect data only when trigger conditions are 
satisfied]

Not available to GT21 and GS21.
Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
8. OBJECT FUNCTION
8.15 Placing a Line Graph

8 - 481



(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Style]

[Frame Color] frame_color ○ ○ ×

[Shape Color] plate_color ○ ○ When the object is updated

[Lower Limit] (X) scale_min[0] ○ ○ When the screen is updated

[Lower Limit] (Y) scale_min[1] ○ ○ When the screen is updated

[Upper Limit] (X) scale_max[0] ○ ○ When the screen is updated

[Upper Limit] (Y) scale_max[1] ○ ○ When the screen is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.15.5 Relevant settings

Set the relevant settings other than the specific settings for the line graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.16 Placing a Trend Graph

Data in a word device can be collected continuously and are displayed in a graph.

8.16.1 Specifications of the trend graph

The following shows the specifications of the trend graph.

■1 Number of trend graphs that can be set
(1) Maximum number of trend graphs on one screen

The maximum number of objects on one screen depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 32 trend graphs and/or historical trend graphs can be placed on one screen.
• For GT21 and GS21

One historical data list display, trend graph, scatter graph, or historical trend graph can be placed on one screen.

(2) Maximum number of lines in one trend graph
The maximum number of lines in one trend graph depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 32 lines are displayable in one graph.

• For GT21 and GS21
Up to four lines are displayable in one graph.

(3) Maximum number of points
The maximum number of points on one line of a trend graph depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 1024 points are displayable.

• For GT21 and GS21
Up to 500 points are displayable.

■2 Difference between trend graphs and historical trend graphs
Historical trend graphs displays data collected and accumulated with logging as graphs.
To accumulate data, use historical trend graphs.

➟8.21 Placing a Historical Trend Graph
9.2 Collecting Device Data ([Logging])

Trend graphs do not accumulate collected data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

200

100

0

200

100

0

200

100

0

D10 = 150
D11 = 100

D10 = 200
D11 = 100

D10 = 100
D11 = 50

Graph 1 (-): D10
Graph 2 (  ): D11

The graph is displayed 
to the edge of the display 
range.

The data collection is 
continued and the following 
graph is displayed by scrolling.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.16.2 How to use the trend graph

The following shows how to use the trend graph.

■1 Placing the Trend Graph
The following shows how to place the trend graph.

Step 1 Select [Object] → [Graph] → [Trend Graph] from the menu.
Step 2 Click the position where you place the trend graph. Placing the trend graph is complete.
Step 3 Adjust the frame size of the trend graph.
Step 4 Double-click the placed trend graph to display the setting dialog.

➟8.16.4 [Trend Graph] dialog
Step 5 Display the [Data] tab.

➟8.16.4 ■1 [Data] tab
Step 6 Set the number of lines and points to be displayed in the trend graph.

Step 7 Set a device to be monitored.

➟6.1.2 How to set devices
Step 8 Set [Lower Limit] and [Upper Limit].
Step 9 Set the scale and figure in the [Style] tab.

➟8.16.4 ■2 [Style] tab

Step 10 Set the graph assistance line and cursor attribute in the [Auxiliary Line/Cursor] tab.

➟8.16.4 ■3 [Auxiliary Line/Cursor] tab

Step 11 Click the [OK] button to complete the trend graph settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display direction (right)

Lower limit, upper limit
(lower limit: 0, upper limit: 1000)

1000

0

Number of lines (2 lines)

Number of points (6 points)

Monitored device (D10, D11)

Scale
 Y (number of lines: 5)
 X (number of points: 7)

100

0

50

0 50 100
Scale value
 Y (number of scale values: 3)
 X (number of scale values: 3)

Figure1000

0

1000

0

100

0

50

0 50 100

Auxiliary line
(reference line)

Cursor
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■2 Identifying multiple graphs (setting user IDs)
When multiple objects that are operated by the touch switch to which the key code are assigned placed on one screen, 
touching the touch switch may operate the object that is not the target.
Setting a user ID limits the objects operated when the touch switch is touched.

The following shows the setting procedure.

(1) Setting of the trend graph
Step 1 Double-click the trend graph placed on the screen editor.

The [Trend Graph] dialog appears.
➟8.16.4 [Trend Graph] dialog

Step 2 Enable [User ID] in the [Extended] tab, and specify the number.

➟8.16.4 ■4 [Extended] tab
The number is used to define the target object as the object that operates when the touch switch is touched.
Do not set [User ID] that is already used for other objects.

(2) Settings of touch switches
Step 1 Display the [Switch] dialog.

For the details of the switch, refer to the following.
➟8.2 Placing a Touch Switch

Step 2 Click the [Key Code] button in the [Action] tab.
Step 3 Enable [Individually set user ID for a key input] and specify a number.

Set the same number as the number specified in [User ID] of [Trend Graph].

Touch switch for
trend graph A 

Touch switch for
trend graph B

Trend graph   B

20151050 25 30
0

25

50
0 3 6 9 12 15 18 21 24

0

300

500
400

200

Trend graph   A

Show cursor

Hide cursor

Refresh

Show cursor

Hide cursor

Upward Downward

Check Deleting 
a project

20151050 25 30
0

25

50
0 3 6 9 12 15 18 21 24

0

300

500
400

200

Trend graph   A

Show cursor

Hide cursor

Refresh

Touch switch for
trend graph A

(User ID: 2)(User ID: 1)

(User ID: 2)(User ID: 1)

When no user ID is set When the user ID is set

The touch switches for trend graph A 
operate for trend graph B.

Although the same key codes are used, 
the target for an operation can be specified with ID numbers. 

Hence operations can be performed as required.

Show cursor

Hide cursor

Refresh

1050
0

100

Touch switch for
trend graph B 

1050
0

100

Trend graph   B
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■3 Storing graph data in devices
The following values displayed in each graph can be stored in devices.

• Value at the cursor
• Maximum value
• Minimum value
• Average value

Even though data operation is set, the value before the data operation is stored.

(1) How to store the data in devices
Set the devices to store the values in [Graph Information] in the [Data] tab.
Set the devices and select the options of data you want to collect.

➟8.16.4 ■1 [Data] tab

(2) Timing with which values are stored in the devices
The timing depends on the model.
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Values are stored to the devices at the following timings.

• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

GT21 and GS21
The value at the cursor is stored to the device at the following timings.

• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

The maximum, minimum, and average values are constantly acquired and stored to the devices.

Example) Storing the value at the cursor, maximum value, and minimum value in GT27

Example) Storing the value at the cursor, maximum value, and minimum value in GT21

Display the cursor

(Time)

Values acquired and stored 
in the devices

Cursor: 50
Max. value: 100
Min. value: 0

Cursor: 0
Max. value: 0
Min. value: 0

The graph is updated.
The cursor is deleted.

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values are reset after 
the update.

Cursor: 75
Max. value: 75
Min. value: 25

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values acquired and stored 
in the devices

75
50
25

0
0 5 10 15 20 25 30

100
(Value) Display the cursor

75
50
25

0
0 5 10 15 20 25 30

100
(Value) Display the cursor Display the cursor

(Time)

The graph is updated.
The cursor is deleted.

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values acquired and stored 
in the devices

Value at the cursor: 
Reset after the update.
Max. and min. values: 
Acquired and stored in the devices 
after the update.

Value at the cursor: 
Acquired and stored in the device.
Max. and min. values: 
No change. Retained.

Cursor: 50
Max. value: 100
Min. value: 0

Cursor: 0
Max. value: 75
Min. value: 25

Cursor: 75
Max. value: 75
Min. value: 25
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■4 Storing date data in devices
The time of the cursor display position, display range beginning position, and display range end position of the graph can 
be stored to the device by using the Time device.

(1) How to store the data to the device
Data is stored in the upper eight bits and lower eight bits of set devices.
Numerical values are stored in BCD.
Example) When [Device] is set to [D100]

(2) Storage timing and values stored to devices
(a) Timing when the value is stored

With the following timings, values are stored to devices.
• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

(b) Values to be stored
When a cursor is displayed on the graph, the drawing processing of the graph stops.
The values at the stop of the draw processing are stored to devices.

(3) Displaying date data in the numerical display
Date data can be displayed in the numerical display.
The following shows the setting procedure.

Step 1 Display the setting dialog for the placed numerical display ([Numerical Display] dialog).
For the details of the numerical display, refer to the following.

➟8.4 Placing a Numerical Display and Numerical Input
Step 2 Select [BCD16], [BCD32], or [BCD64] in [Data Type] in the [Device] tab.
Step 3 Set the mask processing and shift processing in the [Operation/Script] tab.

Item Device Description

[yymm] D100
• b15 to b8: The year is stored.
• b7 to b0: The month is stored.

[ddhh] D101
• b15 to b8: The day is stored.
• b7 to b0: The time (hour) is stored.

[mmss] D102
• b15 to b8: The time (minute) is stored.
• b7 to b0: The time (second) is stored.

[Day] D103

• b15 to b8: None
• b7 to b0:

The day of the week is stored as a numerical value.
The following shows the numerical values 
corresponding to the days.
• 0: Sunday
• 1: Monday
• 2: Tuesday
• 3: Wednesday
• 4: Thursday
• 5: Friday
• 6: Saturday

20151050 25 30
0

50

100

25

75

Show the cursor

20151050 25 30
0

50

100

25

75

Move the cursor

Stores the time displayed 
where the cursor is placed.

Stores the time displayed 
where the cursor is placed.

Data displayed where the cursor 
is placed at the instant when a draw 
processing stops is stored with the 
timing that the cursor is displayed/moved.

Example) Storing a time in the device
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• When displaying upper 8 bits (year)

• When displaying lower 8 bits (month)

■5 Displaying the data obtained at specified time in the center (time specification jump 
function)

By using the display position time device and a touch switch, the data obtained at specified time can be displayed in the 
center of the trend graph.
When no data is obtained at the specified time, the data which has the nearest specified date is displayed.
When the multiple values are obtained at the nearest time, the first detected value is displayed.

(1) How to store the data to the device
Set a device to store the data in the upper eight bits and lower eight bits.
Numerical values are stored in BCD16.
Example) When [Device] is set to [D100]

(2) Setting procedure
(a) Settings of touch switches

To use time specification jump function, the following touch switches are required.
• Touch switch for displaying the specified time
• Touch switch for restarting the drawing processing of the graph

If the time specification jump function is used, the drawing processing of the graph stops.
A touch switch for restarting the drawing processing of the graph is required.
The following shows the setting procedure.

In the numerical display, set the lower 8 bits of D100 
(b7 to b0) to be masked and the upper 8 bits of D100 
(b15 to b8) to be shifted to the right by 8 bits.

In the numerical display, set the upper 8 bits of 
D100 (b15 to b8) to be masked.

Item Device Description

[yymm] D100
• b15 to b8: The year is stored.
• b7 to b0: The month is stored.

[ddhh] D101
• b15 to b8: The day is stored.
• b7 to b0: The time (hour) is stored.

[mmss] D102
• b15 to b8: The time (minute) is stored.
• b7 to b0: The time (second) is stored.
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Step 1 Display the setting dialog for the placed switch ([Switch] dialog).
For the details of the switch, refer to the following.

➟8.2 Placing a Touch Switch
Step 2 Click the [Key Code] button in the [Action] tab.
Step 3 Set the key cord according to the touch switch to be created.

• When setting a touch switch for displaying the specified time
Set [Code Setting] to [FFD4].

• When setting a touch switch for restarting the drawing processing of the graph
Set [Code Setting] to [FFEF].

Using the library data
Touch switches are registered in the library.
➟8.1 Using Objects in the Library

(b) Setting of the trend graph
Step 1 Double-click the trend graph placed on the screen editor.

The [Trend Graph] dialog appears.
➟8.16.4 [Trend Graph] dialog

Step 2 Enable [Display Position Time] in the [Extended] tab, and specify a device.

➟8.16.4 ■4 [Extended] tab

(3) Operation example
The following shows the operation examples.
Example) When setting [D1000] in [Display Position Time Device] and displaying the data of Jun.29, 2013 21:05:30

(4) Precautions
(a) When date data is being searched for

When date data is being searched for, the historical trend graph cannot be operated.

(b) When no data can be displayed on the trend graph
When no data can be displayed on the trend graph, the time specification jump function is not executed.

(c) When displaying the data displayed near the start or end point
If the data obtained at specified time is near the start or end point, it may not be displayed in the center of the graph.

■6 Setting [Collect data only when trigger conditions are satisfied]
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.
The following shows the setting procedure.

Step 1 Select [Object] → [Graph] → [Trend Graph] from the menu.
Step 2 Click the position where you place the trend graph. Placing the trend graph is complete.
Step 3 Double-click the placed trend graph to display the setting dialog.

➟8.16.4 [Trend Graph] dialog
Step 4 Display the [Trigger] tab.

➟8.16.4 ■6 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].

Display Position Time device

Set the time to be displayed in 
the Display Position Time device.

Year and month 
(D1000)

b15
0x13

0x29

0x05

0x06

0x21

0x30

b0

Day and time 
(D1001)
Minute and 
second (D1002)

Time 
specification
jump

The data obtained at the specified time 
(Jun. 29, 2013 21:5:30) can be 
displayed in the center of the list.

Touch the touch switch 
for which the key code 
(FFD4h) has been set.
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Step 6 Set [Collect data only when trigger conditions are satisfied].

Example) Combining the line graph and trend graph

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

8.16.3 Precautions for a trend graph

The following shows the precautions for the trend graph.

■1 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the trend graph is refreshed at timing 1).
• The display of the trend graph is refreshed at timing 2).
• At timing 3), the display of the trend graph is not refreshed because the timing does not match the end of one cycle 

and thus the condition is not checked.

54321
0

50

100

54321
0

50

100

Trigger type       : Sampling (3 seconds)
Collect data only when 
trigger conditions are satisfied  : Disabled
Object       : Trend graph

Communicates in the set cycle and 
refreshes the display frequently.

54321
0

50

100

Trigger type       : Rise
Collect data only when 
trigger conditions are satisfied  : Enabled
Object        : Line graph

Displays the graph (communicates) 
only at startup.

The line graph can be used as 
the reference value and compared 
with the trend graph.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

OFF

Sampling cycle set for 
[Trigger Type]

1 second 1 second 1 second

Device status set for 
[Device]

1) 2)

3)

4) 5)

ON
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• At timing 4), the display of the trend graph is not refreshed because the device condition is not satisfied.
• The display of the trend graph is refreshed at timing 5).

(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

■2 Operation to clear the collected data
The following shows the operation to clear the display of the graph or the collected data (to clear the device value to 0).

• The screen is switched.
• The utility screen is displayed.
• The language is switched.
• The security level is switched.
• The station number is switched.
• When the trend graph is displayed in the superimpose window, the base screen is switched.

■3 When the monitored device value is above the upper limit or below the lower limit
The trend graph does not display a device value that is above the upper limit or below the lower limit.
In such a case, the upper or lower limit symbol appears at the position where the device value is hidden from view.

To hide the upper and lower limit symbols, turn on GS450.b10.
➟12.1.3 GOT special register (GS)

Upper limit value: 1000

Upper and lower limit symbols

D10: 1200

D10: -400

Lower limit value: 0
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8.16.4 [Trend Graph] dialog

The trend graph is an object that constantly collects data in word devices and display it in a graph.
Step 1 Select [Object] → [Graph] → [Trend Graph] from the menu.
Step 2 Click the position where you place the trend graph. Placing the trend graph is complete.
Step 3 Double-click the placed trend graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Auxiliary Line/Cursor] tab
■4 [Extended] tab
■5 [External Output] tab
■6 [Trigger] tab
■7 [Operation/Script] tab

■1 [Data] tab

Set the target device to be monitored and the trend graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Trend Graph]
• [Historical Trend Graph]

2) [Display Format]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Number of Pens]

Set the number of lines to be displayed in the trend graph.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

The setting range is [1] to [32].
• For GT21 and GS21

The setting range is [1] to [4].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4)

2)
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[Points]

Set the number of points to be displayed on a line of the trend graph.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

The setting range is [2] to [1024].
• For GT21 and GS21

The setting range is [2] to [500].
Depending on the number of points and X-axis display range, the interval between points is adjusted 
automatically.

[Direction]

Select the display direction of the graph.
The following shows the items to be selected.
• [Up]
• [Right]
• [Down]
• [Left]

[Display Mode]

The following shows how to draw the trend graph.
The following shows the items to be selected.
• [Pen Record]:

The line of the graph is drawn by moving the whole graph to [Direction].
The point indicating the latest value is always drawn at the graph edge.

• [One by One]
The current value is displayed in the display direction.
When the graph is drawn fully in a display range, the graph being displayed is cleared and a new graph is 
drawn.

• [Next Point Movement]
The line of the graph is drawn to [Direction].
The point indicating the latest value moves to the display direction.
Once the point indicating the latest value reaches to the graph edge, the point is drawn at the graph edge 
constantly.

Item Description

Point interval = 20 dots

Example)
Number of points: 5

X-axis 100 dots

(Display direction: Right)

Graph edge

Latest value

Time flow Time flow

Current value Current value Current value

Display flow

Time flow
(Display direction: Right)

Latest value

Time flow

Latest value

Graph edge
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3) [Device]

[Point Type]

Select the point type.
The following shows the items to be selected.
• [Line]
• [Point]
• [Line + Point]

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Device Setting]

Select how to set the device.
The following shows the items to be selected.
• [Continuous]: When a start device is set, inputs consecutive devices automatically in the table of [Device].
• [Random]: Select this item when setting devices one by one.

[Device]
Set the device to be monitored.

➟6.1.2 How to set devices

[Data Operation]
Set this item to execute the data operation.

➟6.5.5 ■4 (3) [Edit Data Expression] dialog

[Line Attribute]

Set the attribute of the line.
When [Line] or [Line + Point] is selected for [Point Type], set this item.

• [Line Style]
Select the style of the line.
The following shows the items to be selected.
· Solid line
· Dotted line
· Broken line
· One-dot chain line
· Two-dot chain line

• [Width]
Select the width of the line.
The following shows the items to be selected.
· [1 Dot]
· [2 Dot]
· [3 Dot]
· [4 Dot]
· [5 Dot]
· [7 Dot]

• [Line Color]
Select the color of the line.

Item Description

[Line] [Point] [Line + Point]
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[Point Attribute]

Set the attribute of the points.
When [Point] or [Line + Point] is selected for [Point Type], set this item.

• [Type]
Select the style of the point.
The following shows the items to be selected.

• [Size]
Select the size of the point.
The following shows the items to be selected.
· [Large]: 9 dots
· [Medium]: 7 dots
· [Small]: 5 dots
· [Very small]: 3 dots
· [Point]: 1 dot
Only when [0] is selected for [Type], [Very small] or [Point] can be selected.

• [Color]
Set the color of the point.

Item Description

  0:        ,   1:        ,   2:       ,   3:       ,   4:        ,   5:

  6:        ,   7:       ,    8:       ,   9:       , 10:       , 11:

12:        , 13:       , 14:       , 15: 
8. OBJECT FUNCTION
8.16 Placing a Trend Graph

8 - 497



[Graph Information]

Set the device in which the information displayed on the graph is stored or device that clears the line of the 
graph.
For the timings with which values are stored in the devices set for [Maximum Data], [Minimum Data], and 
[Average Data], refer to the following.

➟8.16.2 ■3 Storing graph data in devices

• [Device Data Storage]
Set the device in which the graph information is stored.
The successive devices following the device set in this item are assigned automatically to [Cursor Position 
Data] or later items.
Set each item optionally.
Using the GOT internal device is recommended for this setting.
Even though data operation is set, the value before the data operation is stored.

• [Data Type]
Select the data type of the word device in which graph information is stored.
Select the same data type as that of the device to be monitored.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

• [Cursor Position Data]
Select this item to store the value of device positioned by the cursor.
The device is assigned automatically.

• [Maximum Data]
Select this item to store the maximum value of the device values displayed on the graph is to be stored.
The device is assigned automatically.

• [Minimum Data]
Select this item to store the minimum value of the device values displayed on the graph.
The device is assigned automatically.

• [Average Data]
Select this item to store the average value of the device values displayed on the graph.
The device is assigned automatically.

• [Graph Line External Control]
· [Graph Line Clear Device]
Select this item to clear the line of the graph using a device.
After selecting this item, set the device.

[Step Mode]

Select this item to display the line of the trend graph by steps.

Item Description

Displayed by no steps Displayed by steps
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4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

[Lower Limit] and [Upper 
Limit]

Select whether to specify the display range (lower and upper limit values) of the trend graph with the fixed 
value or with the device value.
The following shows the items to be selected.
• [Fixed]:

Specify a constant.
• [Device]:

Specify a device value.

➟6.1.2 How to set devices
The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2)
3)
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1) [Scale Settings]
Displays the line or scale value in the trend graph.

Item Description

[Axis Position]

Select the position where the line or scale value is displayed.
The following shows the items to be selected.
• [Left] button
• [Right] button
• [Top] button
• [Bottom] button
After selecting the position, set the line or scale value.

[Main Scale]

Set this item to display lines on the scale.

• [Color]
Set the color of lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [101].

[Sub Scale]

Set this item to place lines between the lines set in [Main Scale].

• [Color]
Set the color of sub lines on the scale.

• [Scale Points]
Set the number of sub lines on the scale.
The setting range is [1] to [9].

Line
(X: 5)
(Y: 5)

Scale value
(X: 3)
(Y: 3)

Displays both the lines 
and scale values.

100

500 100

50

0
500 100

100

50

0

20151050 25 30
0

25

50
0 3 6 9 12 15 18 21 24

0

300

500
400

200

Up

Down

Left Right

Without [Sub Scale] With [Sub Scale]
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2) [Vertical Grid] and [Horizontal Grid]
Select this item to display the horizontal or vertical grid.
The number of grids is the same as the number set in [Scale Points] of [Main Scale] and [Sub Scale].
The bottom and left setting in [Axis Position] is prioritized.

After setting this item, select the color of the grid.
3) [Display the graph frame]

Select this item to display the frame of the graph.

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value]
Set the number of numeric characters.
The setting range is [2] to [11].

• [Lower Limit] and [Upper Limit]
Set the lower limit and upper limit of the numerical value.
Changes in this setting are automatically applied to the display.

Depending on the item selected for [Data Type] in the [Data] tab, the setting range is 
different.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Item Description

[Upper Limit]

[Lower Limit]

Automatically 
changed.

Change the scale value of Y
Upper limit value: 100 → 500

100

50
0

500

250

100

50

0 50
0

1000

Horizontal grid

Vertical grid

Graph frame
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4) [Shape]

Item Description

[Shape]

Set the shape of the trend graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

Preview

[Frame Color]

[Shape Color]
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■3 [Auxiliary Line/Cursor] tab

Set the auxiliary line and attribute of the cursor.

1) [Graph Auxiliary Line]

Item Description

[Reference Line], [Lower Limit Line], and 
[Upper Limit Line]

Set this item to place a reference line on the graph.

• [Display Position]
Select whether to specify the line position using a fixed value or device value.
The following shows the items to be selected.
• [Fixed]:

Specify a constant.
• [Device]:

Specify a device value.
➟6.1.2 How to set devices

• [Line Style]
Select the style of the line.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

• [Width]
Select the width of the line.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

• [Line Color]
Select the color of the line.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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2) [Cursor Attribute]
Set the attribute of the cursor.

Item Description

[Line Style]

Select the style of the line.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

[Width]

Select the width of the line.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Line Color] Select the color of the line.
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].

➟8.16.2 ■2 Identifying multiple graphs (setting user IDs)
4) [Single Touch Operation]

Select this item to display a cursor at the touched place.
5) [Display Position Time]

Set this item to display the data obtained at specified time in the center of the graph when the touch switch is 
touched.

Item Description

[Device]

Set the device in which the date data is stored.
The three successive devices following the device set in this item are automatically 
assigned to [yymm], [ddhh], and [mmss].
The date data is stored in the upper eight bits and lower eight bits of each set device.
The data type of the devices is BCD.
➟8.16.2 ■5 Displaying the data obtained at specified time in the center (time specification 

jump function)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

7)

2)

3)

4)

5)

6)
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6) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

7) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [External Output] tab

1) [Time Device]
Stores each date data.
The four successive devices following the device set in this item are automatically assigned to [yymm], [ddhh], 
[mmss], and [Day].
The date data is stored in the upper eight bits and lower eight bits of each set device.
The data type of the devices is BCD.
For how to display the date data stored in the device in the numerical display, refer to the following.

➟8.16.2 ■4 Storing date data in devices

Item Description

[Cursor Position Time] Set this item to store the time of the cursor display position.
After selecting this item, set the device.

[Beginning Position Time] Set this item to store the time at the beginning position of the graph.
After selecting this item, set the device.

[End Position Time] Set this item to store the time at the end position of the graph.
After selecting this item, set the device.

[Always update Beginning Position Time/End 
Position Time]

Select this item to constantly store the latest value in the Time device (beginning position 
time and end position time).
New data obtained at specified time is stored every graph refresh.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■6 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
3) [Settings]

For details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

Item Description

[Collect data only when trigger conditions are 
satisfied]

Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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■7 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Set the expression used for the script function.
➟(2) [Script]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Data]

[Lower Limit] (X (lower side)) scale_min[0] ○ ○ When the screen is updated

[Lower Limit] (Y (left side)) scale_min[1] ○ ○ When the screen is updated

[Lower Limit] (Y (upper side)) scale_min[2] ○ ○ When the screen is updated

[Lower Limit] (Y (right side)) scale_min[3] ○ ○ When the screen is updated

[Upper Limit] (X (lower side)) scale_max[0] ○ ○ When the screen is updated

[Upper Limit] (Y (left side)) scale_max[1] ○ ○ When the screen is updated

[Upper Limit] (Y (upper side)) scale_max[2] ○ ○ When the screen is updated

[Upper Limit] (Y (right side)) scale_max[3] ○ ○ When the screen is updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.16.5 Relevant settings

Set the relevant settings other than the specific settings for the trend graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

[Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the screen is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Hiding the upper and lower limit symbols GS450.b10
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8.17 Placing a Bar Graph

This function collects multiple word device values in a batch and displays the values in a bar graph.

8.17.1 Specifications of the bar graph

The following shows the specifications of the bar graph.

■1 Number of bar graphs that can be set
(1) Number of bar graphs that can be placed

Up to 1024 bar graphs can be placed on one screen.
Up to 256 objects for which [Collect data only when trigger conditions are satisfied] is set can be placed for one project.

(2) Number of bars that can be displayed (number of word devices that can be monitored)
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 500 bars can be displayed in one bar graph.
• For GT21 and GS21

Up to eight bars can be displayed in one bar graph.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.17.2 How to use the bar graph

The following shows how to use the bar graph.

■1 Placing the bar graph
The following shows how to place the bar graph.

Step 1 Select [Object] → [Graph] → [Bar Graph] from the menu.
Step 2 Click the position where you place the bar graph. Placing the bar graph is complete.
Step 3 Adjust the frame size of the bar graph.
Step 4 Double-click the placed bar graph to display the setting dialog.

➟8.17.4 [Bar Graph] dialog
Step 5 Display the [Data] tab.

➟8.17.4 ■1 [Data] tab
Step 6 Set the number of bars (the number of monitored word devices).

Step 7 Set a device to be monitored.

➟6.1.2 How to set devices
Step 8 Set [Lower Limit], [Upper Limit], and [Base Value].
Step 9 Set the scale and figure in the [Style] tab.

➟8.17.4 ■2 [Style] tab

Step 10 Click the [OK] button to complete the bar graph settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

100

-100

0

Lower limit, upper limit
(lower limit: 0, upper limit: 6000)

6000

0

Number of bars (5 bars)

Base value

1 2 3 4 5

Monitored device (D10, D11, D12, D13, D14)

Graph color

100

-100

0

6000

0

Line (number of lines: 5)
Scale value (number of values: 3)

1 2 3 4 5

Figure
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■2 Setting [Collect data only when trigger conditions are satisfied]
Not available to GT21 and GS21.
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.

Step 1 Select [Object] → [Graph] → [Bar Graph] from the menu.
Step 2 Click the position where you place the bar graph. Placing the bar graph is complete.
Step 3 Double-click the placed bar graph to display the setting dialog.

➟8.17.4 [Bar Graph] dialog
Step 4 Display the [Trigger] tab.

➟8.17.4 ■4 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].
Step 6 Set [Collect data only when trigger conditions are satisfied].

Example) Combining the line graph and trend graph

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

54321
0

50

100

54321
0

50

100

Trigger type       : Sampling (3 seconds)
Collect data only when 
trigger conditions are satisfied  : Disabled
Object       : Trend graph

Communicates in the set cycle and 
refreshes the display frequently.

54321
0

50

100

Trigger type       : Rise
Collect data only when 
trigger conditions are satisfied  : Enabled
Object       : Line graph

Displays the graph (communicates) 
only at startup.

The line graph can be used as the reference value 
and compared with the trend graph.
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8.17.3 Precautions for a bar graph

This section explains the precautions for the bar graph.

■1 When the monitored device value exceeds the upper or lower limit value
When the monitored device value exceeds the lower limit value, the display of the lower limit value is applied.
When the monitored device value exceeds the upper limit value, the display of the upper limit value is applied.

■2 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

Not available to GT21 and GS21.

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the bar graph is refreshed at timing 1).
• The display of the bar graph is refreshed at timing 2).
• At timing 3), the display of the bar graph is not refreshed because the timing does not match the end of one cycle 

and thus the condition is not checked.
• At timing 4), the display of the bar graph is not refreshed because the device condition is not satisfied.
• The display of the bar graph is refreshed at timing 5).

(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

(2) Refresh timing when [Sampling], [ON Sampling], or [OFF Sampling] is selected
The sampling cycle count starts and is reset at the following timing.

• When the bar graph is displayed (in screen switching, a security level change, or other possible cases)
• When the language switches
• When the security level changes

After the execution of any of the events, the display is refreshed at the start timing of the sampling cycle.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Upper limit value: 6000

Lower limit value:       0

D13=7000

D11=-1000

OFF

Sampling cycle set for 
[Trigger Type]

1 second 1 second 1 second

Device status set for 
[Device]

1) 2)

3)

4) 5)

ON
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■3 Monitoring a primitive data type global label set using the consecutive device setting (one 
point)

When [Continuous] is selected for [Device Setting] in the [Bar Graph] dialog ([Data] tab) and a primitive data type global 
label is set with one device point, the system alarm (326: The data type of labels/tags do not match.) occurs.
To solve the above problem, take one of the following corrective actions.

• Select [Random] for [Device Setting] in the [Bar Graph] dialog ([Data] tab).
• Set an array-type global label.

8.17.4 [Bar Graph] dialog

The bar graph is an object that collects multiple word device values in a batch and displays the values in a graph.
Step 1 Select [Object] → [Graph] → [Bar Graph] from the menu.
Step 2 Click the position where you place the bar graph. Placing the bar graph is complete.
Step 3 Double-click the placed bar graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Data] tab

Set the device to be monitored and the bar graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Line Graph]
• [Bar Graph]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4)

6)

2)

5)
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2) [Number of Pens]
Set the number of bars to be displayed.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [500].

• For GT21 and GS21
The setting range is [1] to [8].

3) [Direction]
Select the display direction of the graph.
The following shows the items to be selected.

• [Vertical]
• [Horizontal]

4) [Device]

5) [Lower Limit], [Upper Limit], and [Base Value]
Select whether to specify the display range (lower and upper limit values and a base value) of the line graph with 
the fixed value or with the device value.
The following shows the items to be selected.

• [Fixed]:
Specify a constant.

• [Device]:
Specify a device value.
➟6.1.2 How to set devices

The setting range of [Lower Limit], [Upper Limit], and [Base Value] differs depending on the item selected for [Data 
type].

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Device Setting]

Select how to set the device.
The following shows the items to be selected.
• [Continuous]: When a start device is set, inputs consecutive devices automatically in the table of [Device].
• [Random]: Select this item when setting devices one by one.

[Device]
Set the device to be monitored.
➟6.1.2 How to set devices

[Graph] Select the color of the bar.

[Pattern], [Background Color]

Select the pattern and the background color to be used for the bar.

Monitored 
device value

Set order of 
the devices

Set order of the devices Monitored device value

[Vertical] [Horizontal]

[Pattern] + [Graph]

[Background Color]

Example)

[Background Color]
[Pattern]
[Graph] :

:
:
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6) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Shape]

Item Description

[Shape]

Set the shape of the bar graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

Preview

[Shape Color]

[Frame Color]
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2) [Scale Settings]
Displays the line or scale value in the bar graph.

Item Description

[Scale]

Set this item to display lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [101].

• [Color]
Set the color of lines on the scale.

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value] ([Horizontal] and [Vertical])
Set the number of numeric characters.
The setting range is [0] and [2] to [101].

• [Lower Limit] ([Horizontal] and [Vertical]) and [Upper Limit] ([Horizontal] and 
[Vertical])
Set the lower limit and upper limit of the numerical value.
Changes in this setting are automatically applied to the display.

Depending on the item selected for [Data Type] in the [Data] tab, the setting range is 
different.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Line
(X: 5)
(Y: 5)

Scale value
(X: 3)
(Y: 3)

Displays both the lines 
and scale values.

100

500 100

50

0
500 100

100

50

0

100

0

-100

Set the lower limit value 
of the scale value to 0.

100

50

0

Automatically 
changed

[Upper Limit]

[Lower Limit]
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3) [Bar Graph Attribute]

[Display the graph frame]

Select this item to display the frame of the graph.

Item Description

[Graph Width]

Set the width of the bar.
The setting range is [1] to [500] dot(s).
In the actual display, one dot of the boundary width is added to the value set for this item.
([Vertical]: Left, [Horizontal]: Top)

[Offset to Frame]

Set the space between the origin point and the bar nearest to the origin point.
The setting range is [0] to [100] dot(s).

[Width + Space]

Set the space between adjoining bars.
The setting range is [1] to [500] dot(s).
The setting value includes the displayed width.

[Sort]

Select the sorting order when sorting bars according to the device values.
The following shows the items to be selected.
• [None]
• [Ascending]
• [Descending]

Item Description

Graph frame

Boundary (1 dot) Boundary (1 dot)

Displayed width: Bar width + Boundary width

Space between 
the origin point 
and the bar

Space between 
the origin point 
and the bar

Space (including the bar width)

Vertical direction Horizontal direction

[Ascending]

Vertical direction Horizontal direction

[Descending]
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)

4)
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■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Not available to GT21 and GS21.
Set the expression used for the script function.

➟(2) [Script]

Item Description

[Collect data only when trigger conditions are 
satisfied]

Not available to GT21 and GS21.
Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Style]

[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Lower Limit] (X) scale_min[0] ○ ○ When the screen is updated

[Lower Limit] (Y) scale_min[1] ○ ○ When the screen is updated

[Upper Limit] (X) scale_max[0] ○ ○ When the screen is updated

[Upper Limit] (Y) scale_max[1] ○ ○ When the screen is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.17.5 Relevant settings

Set the relevant settings other than the specific settings for the bar graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.18 Placing a Statistics Bar Graph

This function collects multiple word device values in a batch and displays the ratio of each value to the total of all the 
collected values in a bar graph.

■1 Application examples
(1) Displaying the graph on the same screen as the historical data list display

By displaying the graph on the same screen as the historical data list display, the device status can be described more 
effectively.

➟8.10 Placing a Historical Data List Display

(2) Sorting the graph according to the device values
The graph can be sorted in ascending or descending order of the device values.

8.18.1 Specifications of the statistics bar graph

The following shows the specifications of the statistics bar graph.

■1 Number of statistics bar graphs that can be set
(1) Number of statistics bar graphs that can be placed

Up to 32 statistics bar graphs can be placed on one screen.
Up to 256 objects for which [Collect data only when trigger conditions are satisfied] is set can be placed for one project.

(2) Number of values that can be displayed (number of word devices that can be monitored)
Up to 32 values can be displayed in one statistics bar graph.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10 33
D20
D30

33
34

D10 12
D20
D30

76
12

Name Target qty Product qty

Machine 1 5000 2000

Machine 2 5000 1200

Machine 3 5000 1000

No.

1

2

3
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8.18.2 How to use the statistics bar graph

The following shows how to use the statistics bar graph.

■1 Placing the statistics bar graph
The following shows how to place the statistics bar graph.

Step 1 Select [Object] → [Graph] → [Statistics Bar Graph] from the menu.
Step 2 Click the position where you place the statistics bar graph. Placing the statistics bar graph is complete.
Step 3 Adjust the frame size of the statistics bar graph.
Step 4 Double-click the placed statistics bar graph to display the setting dialog.

➟8.18.4 [Statistics Bar Graph] dialog
Step 5 Set the number of divisions (number of the word device to be monitored), device to be monitored, and the 

color of the graph in the [Data] tab.

➟8.18.4 ■1 [Data] tab

Step 6 Set the scale and figure in the [Style] tab.

➟8.18.4 ■2 [Style] tab

Step 7 Click the [OK] button to complete the statistics bar graph settings.

■2 Setting [Collect data only when trigger conditions are satisfied]
Not available to GT21 and GS21.
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.

Step 1 Select [Object] → [Graph] → [Statistics Bar Graph] from the menu.
Step 2 Click the position where you place the statistics bar graph. Placing the statistics bar graph is complete.
Step 3 Double-click the placed statistics bar graph to display the setting dialog.

➟8.18.4 [Statistics Bar Graph] dialog
Step 4 Display the [Trigger] tab.

➟8.18.4 ■4 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].
Step 6 Set [Collect data only when trigger conditions are satisfied].

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Graph type, 
number of divisions, 
graph color
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Figure
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8.18.3 Precautions for a statistics bar graph

This section explains the precautions for the statistics bar graph.

■1 When the monitored device value is minus
In the statistics bar graph, the absolute value is displayed when the monitored device value is minus.
Example) When D101 is -30

■2 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the statistics bar graph is refreshed at timing 1).
• The display of the statistics bar graph is refreshed at timing 2).
• At timing 3), the display of the statistics bar graph is not refreshed because the timing does not match the end of one 

cycle and thus the condition is not checked.
• At timing 4), the display of the statistics bar graph is not refreshed because the device condition is not satisfied.
• The display of the statistics bar graph is refreshed at timing 5).

(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

(2) Refresh timing when [Sampling], [ON Sampling], or [OFF Sampling] is selected
The sampling cycle count starts and is reset at the following timing.

• When the statistics bar graph is displayed (in screen switching, a security level change, or other possible cases)
• When the language switches
• When the security level changes

After the execution of any of the events, the display is refreshed at the start timing of the sampling cycle.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100 = 20 D101 = -30 D102 = 50

0 20 40 60 80 100

Displayed as 30.

OFF

Sampling cycle set for 
[Trigger Type]

1 second 1 second 1 second

Device status set for 
[Device]

1) 2)

3)

4) 5)

ON
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8.18.4 [Statistics Bar Graph] dialog

The statistics bar graph is an object that collects multiple word device values in a batch and displays the ratio of each 
value to the total of the collected values in a bar graph.

Step 1 Select [Object] → [Graph] → [Statistics Bar Graph] from the menu.
Step 2 Click the position where you place the statistics bar graph. Placing the statistics bar graph is complete.
Step 3 Double-click the placed statistics bar graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Data] tab

Set the target device to be monitored and the statistics bar graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Bar (Rectangle)]
• [Pie (Circle)]

2) [Number of Divisions]
Set the number of values that can be displayed (number of word devices that can be monitored).
The setting range is [2] to [32].

3) [Direction]
Select the display direction of the graph.
The following shows the items to be selected.

• [Up]
• [Down]
• [Right]
• [Left]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4) [Device]

5) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Device Setting]

Select how to set the device.
The following shows the items to be selected.
• [Continuous]: When a start device is set, inputs consecutive devices automatically in the table of [Device].
• [Random]: Select this item when setting devices one by one.

[Device]
Set the device to be monitored.
➟6.1.2 How to set devices

[Graph] Select the color of the bar.

[Pattern], [Background Color]

Select the pattern and the background color to be used for the bar.

Up
D12

D11

D10

Right

D10 D11 D12

Down
D10

D11

D12

Left

D12 D11D10

[Pattern] + [Graph]

[Background Color]

Example)

[Background Color]
[Pattern]
[Graph] :

:
:
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Shape]

Item Description

[Shape]

Set the shape of the statistics bar graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

Preview

Plate color

Frame color
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2) [Scale Settings]
Displays the line or scale value in the statistics bar graph.

3) [Sort]
Select the sorting order when sorting the graph in ascending or descending order of the device values.
The following shows the items to be selected.

• [None]
• [Ascending]
• [Descending]

Item Description

[Scale]

Set this item to display lines on the scale.

• [Color]
Set the color of lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [0] and [2] to [101].

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value]
Set the number of numeric characters.
The setting range is [0] and [2] to [101].

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Number of 
lines: 9

Scale 
value: 5

0
25

75
50

Displays both the lines 
and scale values.

100

0
25

75
50

100

[Ascending] [Descending]
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3) 4)
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■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Set the expression used for the script function.
➟(2) [Script]

Item Description

[Collect data only when trigger conditions are 
satisfied]

Not available to GT21 and GS21.
Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.18.5 Relevant settings

Set the relevant settings other than the specific settings for the statistics bar graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.19 Placing a Statistics Pie Graph

This function collects multiple word device values in a batch and displays the ratio of each value to the total of all the 
collected values in a pie graph.

■1 Application examples
(1) Displaying the graph on the same screen as the historical data list display

By displaying the graph on the same screen as the historical data list display, the device status can be described more 
effectively.

➟8.10 Placing a Historical Data List Display

(2) Sorting the graph according to the device values
The graph can be sorted in ascending or descending order of the device values.

8.19.1 Specifications of the statistics pie graph

The following shows the specifications of the statistics pie graph.

■1 Number of statistics pie graphs that can be set
(1) Number of statistics pie graphs that can be placed

Up to 32 statistics pie graphs can be placed on one screen.
Up to 256 objects for which [Collect data only when trigger conditions are satisfied] is set can be placed for one project.

(2) Number of values that can be displayed (number of word devices that can be monitored)
Up to 32 values can be displayed on one statistics pie graph.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10 33
D20
D30

33
34

D10 12
D20
D30

76
12

Name Target qty Product qty

Machine 1 5000 2000

Machine 2 5000 1200

Machine 3 5000 1000

No.

1

2

3
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8.19.2 How to use the statistics pie graph

The following shows how to use the statistics pie graph.

■1 Placing the statistics pie graph
The following shows how to place the statistics pie graph.

Step 1 Select [Object] → [Graph] → [Statistics Pie Graph] from the menu.
Step 2 Click the position where you place the statistics pie graph. Placing the statistics pie graph is complete.
Step 3 Adjust the frame size of the statistics pie graph.
Step 4 Double-click the placed statistics pie graph to display the setting dialog.

➟8.19.4 [Statistics Pie Graph] dialog
Step 5 Set the number of divisions (number of the word device to be monitored), device to be monitored, and the 

color of the graph in the [Data] tab.

➟8.19.4 ■1 [Data] tab

Step 6 Set the scale and figure in the [Style] tab.

➟8.19.4 ■2 [Style] tab

Step 7 Click the [OK] button to complete the statistics pie graph settings.

■2 Setting [Collect data only when trigger conditions are satisfied]
Not available to GT21 and GS21.
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.

Step 1 Select [Object] → [Graph] → [Statistics Pie Graph] from the menu.
Step 2 Click the position where you place the statistics pie graph. Placing the statistics pie graph is complete.
Step 3 Double-click the placed statistics pie graph to display the setting dialog.

➟8.19.4 [Statistics Pie Graph] dialog
Step 4 Display the [Trigger] tab.

➟8.19.4 ■4 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].
Step 6 Set [Collect data only when trigger conditions are satisfied].

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Graph type, 
number of divisions, 
graph color0

33.366.7

Device (D10, D11, D12)

0

50

2575
Line (number of lines: 4)

Scale value (number of values: 4)

Figure
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8.19.3 Precautions for a statistics pie graph

This section explains the precautions for the statistics pie graph.

■1 When the monitored device value is minus
In the statistics pie graph, the absolute value is displayed when the monitored device value is minus.
Example) When D101 is -30

■2 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

Not available to GT21 and GS21.

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the statistics pie graph is refreshed at timing 1).
• The display of the statistics pie graph is refreshed at timing 2).
• At timing 3), the display of the statistics pie graph is not refreshed because the timing does not match the end of one 

cycle and thus the condition is not checked.
• At timing 4), the display of the statistics pie graph is not refreshed because the device condition is not satisfied.
• The display of the statistics pie graph is refreshed at timing 5).

(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

(2) Refresh timing when [Sampling], [ON Sampling], or [OFF Sampling] is selected
The sampling cycle count starts and is reset at the following timing.

• When the statistics pie graph is displayed (in screen switching, a security level change, or other possible cases)
• When the language switches
• When the security level changes

After the execution of any of the events, the display is refreshed at the start timing of the sampling cycle.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100 = 20

D101 = -30
D102 = 50

Displayed as 30.

OFF

Sampling cycle set for 
[Trigger Type]

1 second 1 second 1 second

Device status set for 
[Device]

1) 2)

3)

4) 5)

ON
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8.19.4 [Statistics Pie Graph] dialog

The statistics pie graph is an object that collects multiple word device values in a batch and displays the ratio of each 
value to the total of the collected values in a pie graph.

Step 1 Select [Object] → [Graph] → [Statistics Pie Graph] from the menu.
Step 2 Click the position where you place the statistics pie graph. Placing the statistics pie graph is complete.
Step 3 Double-click the placed statistics pie graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation/Script] tab

■1 [Data] tab

Set the target device to be monitored and the statistics pie graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Bar (Rectangle)]
• [Pie (Circle)]

2) [Number of Divisions]
Set the number of values that can be displayed (number of word devices that can be monitored).
The setting range is [2] to [32].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Device]

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Device Setting]

Select how to set the device.
The following shows the items to be selected.
• [Continuous]: When a start device is set, inputs consecutive devices automatically in the table of [Device].
• [Random]: Select this item when setting devices one by one.

[Device]
Set the device to be monitored.
➟6.1.2 How to set devices

[Graph] Select the color of the pie.

[Pattern], [Background Color]

Select the pattern and the background color to be used for the pie.

[Pattern] + [Graph]

[Background Color]

Example)

[Background Color]
[Pattern]
[Graph] :

:
:
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Shape]

Item Description

[Shape]

Set the shape of the statistics pie graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2)

3)

Preview

Plate color

Frame color
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2) [Scale Settings]
Displays the line or scale value in the statistics pie graph.

3) [Sort]
Select the sorting order when sorting the graph in ascending or descending order of the device values.
The following shows the items to be selected.

• [None]
• [Ascending]
• [Descending]

Item Description

[Scale]

Set this item to display lines on the scale.

• [Color]
Set the color of lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [0] and [2] to [101].

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value]
Set the number of numeric characters.
The setting range is [0] and [2] to [101].

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Number of 
lines: 8

Scale 
value: 4

0

2575

50
Displays both the lines 

and scale values.

0

2575

50

[Ascending] [Descending]
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■3 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

■5 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Not available to GT21 and GS21.
Set the expression used for the script function.

➟(2) [Script]

Item Description

[Collect data only when trigger conditions are 
satisfied]

Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.19.5 Relevant settings

Set the relevant settings other than the specific settings for the statistics pie graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.20 Placing a Scatter Graph

This function displays a graph using the values of two word devices as the coordinates of X-axis and Y-axis.
The following two types of the scatter graph are available.

■1 Sample
Collects two word device values and displays the values as a single point.
When the graph is refreshed, the new point is displayed with the previously displayed points. (Locus)

(1) When the display attribute is set to "point"

(2) When the display attribute is set to "line"

■2 Batch display
Collects multiple sets of two word device values and displays them as multiple points.
You can select whether the points displayed previously are held or deleted when updating the display of the graph.

(1) When the display attribute is set to "point"

(2) When the display attribute is set to "line"

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.20.1 Specifications of the scatter graph

The following shows the specifications of the scatter graph.

■1 Number of scatter graphs that can be set
(1) Maximum number of scatter graphs on one screen

The maximum number of objects on one screen depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 24 scatter graphs can be placed on one screen.
Up to 16 scatter graphs for which [Store Memory] is set can be placed for one project.
Up to 256 objects for which [Collect data only when trigger conditions are satisfied] is set can be placed for one 
project.

• For GT21 and GS21
One historical data list display, trend graph, scatter graph, or historical trend graph can be placed on one screen.

(2) Number of points that can be displayed (by two word device values)
Up to 500 points can be displayed on one scatter graph.

8.20.2 How to use the scatter graph

The following shows how to use the scatter graph.

■1 Placing the scatter graph
The following shows how to place the scatter graph.

Step 1 Select [Object] → [Graph] → [Scatter Graph] from the menu.
Step 2 Click the position where you place the scatter graph. Placing the scatter graph is complete.
Step 3 Adjust the frame size of the scatter graph.
Step 4 Double-click the placed scatter graph to display the setting dialog.

➟8.20.4 [Scatter Graph] dialog
Step 5 Set the graph type, device, upper limit value, and lower limit value in the [Data] tab.

➟8.20.4 ■1 [Data] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Lower limit and upper limit for X-axis 
(lower limit: 0, upper limit: 600)

0 600

Graph type (sample)

Upper limit for Y-axis 
(lower limit: 0, upper limit: 10000)

10000

0

Target device (X-axis: D10, Y-axis: D11)
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Step 6 Set the scale and figure in the [Style] tab.

➟8.20.4 ■2 [Style] tab

Step 7 Set the display type and attribute switching of the graph in the [Point/Line Attribute] tab.

➟8.20.4 ■3 [Point/Line Attribute] tab
• Display type

• Attribute switching

Step 8 Click the [OK] button to complete the scatter graph settings.

100

0

-100
-100 0 100

Line
(Number of lines   X: 7, Y: 5)

Scale value
(Number of values    X: 3, Y: 3)
: The default value is displayed 
  (upper limit: 100, lower limit: -100).

0 600

10000

0

Figure

Display attribute
 : Select either of point or line.

Point

Line

100

0

-100
-100 0 100

0 600

10000

0

100

0

-100
-100 0 100

0 600

Attribute switching (bit, switching device: M10)
  : Switches between two types of the display attribute.

Set the attribute to be displayed in [Attribute] shown in below.

Attribute (ON:    OFF:    )
: Set the attribute that controls the display according to the M10 status.

When M10 is ON, 
the point is displayed in   .●

When M10 is OFF, 
the point is displayed in    .▲

10000

0
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■2 Setting [Collect data only when trigger conditions are satisfied]
With the setting of [Collect data only when trigger conditions are satisfied], the number of communication can be reduced.
Various graphs can be combined.
The following shows the setting procedure.

Step 1 Select [Object] → [Graph] → [Scatter Graph] from the menu.
Step 2 Click the position where you place the scatter graph. Placing the scatter graph is complete.
Step 3 Double-click the placed scatter graph to display the setting dialog.

The [Scatter Graph] dialog appears.
➟8.20.4 [Scatter Graph] dialog

Step 4 Display the [Trigger] tab.

➟8.20.4 ■5 [Trigger] tab
Step 5 Select either of [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] in [Trigger Type].
Step 6 Set [Collect data only when trigger conditions are satisfied].

Example) Combining the line graph and trend graph

[Collect data only when trigger conditions are satisfied] setting is effective for the graph that does not require frequent 
refresh.
However, when the graph is required to be refreshed or displayed frequently, [Collect data only when trigger conditions 
are satisfied] should not be set (device values are collected through constant communication).
The setting of [Collect data only when trigger conditions are satisfied] may cause the delay of the screen refresh or 
incorrect display of the screen.

54321
0

50

100

54321
0

50

100

Trigger type                                 : Sampling (3 seconds)
Collect data only when 
trigger conditions are satisfied    : Disabled
Object                                         : Trend graph

Communicates in the set cycle and 
refreshes the display frequently.

54321
0

50

100

Trigger type                                 : Rise
Collect data only when 
trigger conditions are satisfied    : Enabled
Object                                         : Line graph

Displays the graph (communicates) 
only at startup.

The line graph can be used as the reference value 
and compared with the trend graph.
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■3 Memory storage
The following operations clear the display of the graph or data (device value: 0). To save the data, set [Store Memory].
Set [Store Memory] in the [Extended] tab.

*1 When the memory storage is not set, switching the security level by selecting [Common] → [GOT Environmental Setting] 
→ [Security] from the menu or the value of the device set as a level device clears the display and the device value to 0.

Example) Action at screen switching
• [Graph Type]: [Sample]
• X-axis device: D100
• Y-axis device: D101

(1) Maximum number of displayed points that can be saved to the memory
Up to 4096 points displayed in the scatter graph can be saved in the internal memory.
(For GT21 and GS21, up to 500 displayed points of data are saved.)
The maximum number of data collections to the memory varies with the selection for [Graph Type] on the [Data] tab in 
the [Scatter Graph] dialog.
The following shows the maximum number of data collections.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
When [Sample] is selected: 4096
When [Batch] is selected: 4096/Number of displayed points (The fractional portion is rounded off.)

• For GT21 and GS21
When [Sample] is selected: 500
When [Batch] is selected: 500/Number of displayed points (The fractional portion is rounded off.)

In [Operation at frequency over time] on the [Extended] tab, set the operation to be executed when the number of 
displayed points exceeds the upper limit.

Item [Store Memory] is deselected [Store Memory] is selected

Switching the screen or 
utility

Switching from the screen 
for which a scatter graph is 
set to the screen for which 
no scatter graph is set

The device value is held. The device value is held.

Switching from the screen 
for which no scatter graph 
is set to the screen for 
which a scatter graph is set

• The display is cleared.
• The device value is cleared to 
0.

• The display is held.
• The device value is held.

Switching the language switching device

Switching the base screen while a scatter graph is 
displayed on the superimpose window

Switching the security level*1

Switching the station No. switching device

100

50

0
50  0 100

D100

D101

50

50

Device value

Production menu

Line 1

Line 2

D100

D101

50

Device values are changed.

100

25

0

100

Switch the screen 
to base screen 5.

Displays base 
screen 1 again.

Base screen 5

100

50

0
50  0 100

100

50

0
50  0 100

Data is newly collected and displayed. 
Only the current device values are 

displayed in the graph.

Device values before the screen has been 
switched to another and device values 

collected while other screens are displayed 
are also displayed in the graph.

Base screen 1

Store data to the memory.

Not store data to the memory
Base screen 1

Base screen 1

50
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• [Interrupt]: Interrupts the data collection.
• [Initialize and Continue]: Clears the data in the internal memory and the display on the scatter graph, and resumes 

the data collection.

Using the system alarm
You can use the system alarm to display an error code and error message when the number of collections of 
device values saved in the memory exceeds the upper limit.
➟9.1.3 Collecting alarms by monitoring the system

(2) Clear timing of the display contents stored in the memory
The following shows the clear timing of the display contents stored in the memory.

• The condition of the clear trigger is satisfied.
• When [Initialize and Continue] is selected in [Operation at frequency over time], the number of collected points that 

can be stored in the memory exceeds the maximum.
• The GOT is reset or turned off.
• Package data is written into the GOT.
• The drive information is displayed.
• An operation that causes the GOT reset at the setup of the utility is executed.

■4 Writing the cumulative count and average value
The cumulative collection count and average value of the data, maximum value, and minimum value collected in the 
scatter graph can be written to a device.
The following shows an example.

• X-device (horizontal): D100
• Y-device (vertical): D200

*1 The value rounded down after the decimal point is written to [Average Value Write].
When [Data Type] (in the [Data] tab) of the device to be monitored is a real number, a value including the decimal is written.
An average value is calculated from the values collected at each collection, and an error may occur.

*2 The device value exceeding the maximum value or minimum value of the scatter graph to be monitored is written as the 
maximum value or minimum value.

Detail Written value

Cumulative count 4

X-axis

Average value*1 200

Maximum value*2 300

Minimum value*2 50

Y-axis

Average value*1 187

Maximum value*2 250

Minimum value*2 100

400
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100
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100  0 200 300

400

300

200
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400
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100  0 200 300

 50
250
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200
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100
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(1) Maximum number of collections that can be counted in the cumulative count or average value
Depending on the device’s [Data Type] set in the [Data] tab in the [Scatter Graph] dialog, the maximum number of 
collections that can be counted in the cumulative count or average value is different.

*1 For [Signed BIN8] or [Unsigned BIN8], data is written to the lower-order byte (0 to 255) of the device.
Set the operation that is executed when the cumulative count exceeds the maximum number of collections in [Operation 
at frequency over time] in the [Extended] tab.

• Interrupt: Data collection is interrupted.
• Initialize and continue: The internal memory and display of the scatter graph are initialized, and new data is collected.

Using the system alarm
You can use the system alarm to display an error code and error message when the cumulative count exceeds 
the upper limit.
➟9.1.3 Collecting alarms by monitoring the system

(2) Initialization timing of the cumulative count, average value, maximum value, and minimum value
The value 0 is written to the cumulative count, average value, maximum value, and minimum value.
The following shows the initialization timing.

• The condition of the clear trigger (in the [Trigger] tab) is satisfied.
• When [Operation at frequency over time] is set to [Initialize and Continue], the cumulative count exceeds the limit.
• The screen is switched.

When the screen for which a scatter graph is placed (base screen or window screen) is switched, the cumulative count 
and average value are held. However, the cumulative count and average value is initialized when the screen is switched 
to the screen for which a scatter graph is placed.
The scatter graph placed on the superimpose window is initialized when the base screen is switched.

• The security level is switched.
• The station number is switched.

(3) When the cumulative count and average value are written and the memory storage are used 
simultaneously
Use [Cumulative/Average] and [Store Memory] simultaneously to collect the cumulative count and average value 
continuously, regardless of the screen switching.
Up to the maximum number of collections for the memory storage, the cumulative count and average value can be 
written.
For the maximum number of collections for the memory storage, refer to the following.

➟8.20.2 ■3 (1) Maximum number of displayed points that can be saved to the memory

[Data Type] Maximum number of collections

[Signed BIN16]
[Unsigned BIN16]
[Signed BIN32]
[Unsigned BIN32]
[Signed BIN64]
[Unsigned BIN64]
[Signed BIN8]
[Unsigned BIN8]
[BCD32]
[BCD64]
[Real(32bit)]
[Real(64bit)]

65535 *1

[BCD16] 9999
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8.20.3 Precautions for a scatter graph

This section explains the precautions for the scatter graph.

■1 When the monitored device value exceeds the upper or lower limit value
When the monitored device value exceeds the lower limit value, the display of the lower limit value is applied.
When the monitored device value exceeds the upper limit value, the display of the upper limit value is applied.

■2 When displaying the superimpose window
Place the superimpose window not to overlap with the scatter graph.
The area of the scatter graph overlapped with the superimpose window is hidden.
To display the scatter graph fully, set [Store Memory] for the scatter graph.

■3 Cause for when the graph display is not refreshed in the set cycle set and measure against 
it

(1) Refresh timing when [ON Sampling] or [OFF Sampling] is selected
Not available to GT21 and GS21.
The graph display may not be refreshed in the set cycle.

(a) Cause
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the display is not refreshed.
Example) [Trigger Type] is set to [ON Sampling] and [Sampling] is set to [1] second

• The display of the scatter graph is refreshed at timing 1).
• The display of the scatter graph is refreshed at timing 2).
• At timing 3), the display of the scatter graph is not refreshed because the timing does not match the end of one cycle 

and thus the condition is not checked.
• At timing 4), the display of the scatter graph is not refreshed because the device condition is not satisfied.
• The display of the scatter graph is refreshed at timing 5).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

(800, 11000)

Lower limit 
value: 0

Lower limit 
value: 0

Upper limit 
value: 10000

Upper limit 
value: 600

(-1000, -1500)

Base screen
Superimpose 
window When [Store Memory] is setWhen [Store Memory] is not set

The area overlapped with 
the superimpose window 
is displayed.

The scatter graph 
is displayed not fully.

OFF

Sampling cycle set for [Trigger Type]
1 second 1 second 1 second

Device status set for [Device]

1) 2)

3)

4) 5)

ON
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(b) Measure
The sampling cycle set for [Trigger Type] does not depend on the device status.
(The sampling cycle does not change whether the device is turned on or off.)
The following shows the setting procedure to start the cycle according to the device status.

Step 1 Select [Rise] or [Fall] for [Trigger Type].
Step 2 Create a sequence program that turns the device on or off when the display should be refreshed.

(2) Refresh timing when [Sampling], [ON Sampling], or [OFF Sampling] is selected
[ON Sampling] and [OFF Sampling] are not available to GT21 and GS21.
Depending on the setting of [Store Memory], the refresh timing is different.

(a) When the memory storage is to be executed
The following shows the start and reset timing of the count of the cycle.

• When the scatter graph is displayed (in screen switching, a security level change, or other possible cases)
• The language is switched.
• The station number is switched.
• The security level is switched.

After the execution of any of the events above, the display is refreshed at the start timing of the sampling cycle.

(b) When the memory storage is not to be executed
The following shows the start and reset timing of the count of the cycle.

• The GOT is started.
• Package data is written into the GOT.
• The drive information is displayed.
• An operation that resets the GOT is executed in the utility.

After the execution of any of the events above, the display is refreshed at the start timing of the sampling cycle.

■4 Number of the plotted points or lines

Under the following conditions, if the number of the plotted points or lines exceeds 1000, the oldest point or line is deleted 
and a new one is plotted.

• [Graph Type] is set to [Sample], and [Store Memory] is deselected.
• [Graph Type] is set to [Batch], [Display Mode] is set to [Locus], and [Store Memory] is deselected.

GOT Graphic Ver.2
8. OBJECT FUNCTION
8.20 Placing a Scatter Graph

8 - 561



8.20.4 [Scatter Graph] dialog

The scatter graph is an object that displays a graph using the values of two word devices as the coordinates of X-axis 
and Y-axis.

Step 1 Select [Object] → [Graph] → [Scatter Graph] from the menu.
Step 2 Click the position where you place the scatter graph. Placing the scatter graph is complete.
Step 3 Double-click the placed scatter graph to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Point/Line Attribute] tab
■4 [Extended] tab
■5 [Trigger] tab
■6 [Operation/Script] tab

■1 [Data] tab

Set the target device to be monitored and the trend graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Sample]
• [Batch]

2) [Points]
Set this item when [Batch] is selected for [Graph Type].
Set the number of points to be displayed in a scatter graph.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [2] to [500].

• For GT21 and GS21
When [Continuous] is selected for [Device Setting], the setting range is [2] to [500].
When [Random] is selected for [Device Setting], the setting range is [2] to [50].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

5)

2)

6)

3)
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3) [Display Mode]
Set this item when [Batch] is selected for [Graph Type].
Select the refresh method of the display of the graph.
The following shows the items to be selected.

• [Replace]
Only the latest data is displayed.

• [Locus] (Not available to GT21 and GS21)
The latest data is displayed on the graph displayed previously.

4) [Device]

5) [X] and [Y]
Set the display range in the scatter graph (lower limit and upper limit) for each axis.
Select whether to use a fixed value or device value.
The following shows the items to be selected.

• [Fixed]:
Specify a constant.

• [Device]:
Specify a device value.
➟6.1.2 How to set devices

The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].
6) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

Item Description

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Device Setting]

Select the display method of the devices in each of X-axis and Y-axis.
The following shows the items to be selected.
• [Continuous]:

When a start device is set, inputs consecutive devices automatically in the table of 
[Device].

• [Random]
Select this item when setting devices one by one.

[X Device] and [Y Device]
Set the devices to be monitored for X-axis and Y-axis.
➟6.1.2 How to set devices
8. OBJECT FUNCTION
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■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Shape]

Item Description

[Shape]

Set the shape of the scatter graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

Preview

[Frame Color]

[Shape Color]
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2) [Scale Settings]
Displays the line or scale value in the scatter graph.

Item Description

[Scale]

Set this item to display lines on the scale.

• [Color]
Set the color of lines on the scale.

• [Scale Points] ([Horizontal] and [Vertical])
Set the number of lines on the scale.
The setting range is [0] and [2] to [101].

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value] ([Horizontal] and [Vertical])
Set the number of numeric characters.
The setting range is [0] and [2] to [101].

• [Lower Limit] ([Horizontal] and [Vertical]) and [Upper Limit] ([Horizontal] and 
[Vertical])
Set the lower limit and upper limit of the numerical value.
Changes in this setting are automatically applied to the display.

Depending on the item selected for [Data Type] in the [Data] tab, the setting range is 
different.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Line
(X: 5)
(Y: 5)

Scale value
(X: 3)
(Y: 3)

Displays both the lines 
and scale values.

100

500 100

50

0
500 100

100

50

0

100

-100

0

0-100 100

[Lower Limit]

100

-100

0

50-100 200

Change the scale value of X.
Upper limit: 100 → 200

Automatically changed
[Upper Limit]

[Upper Limit]
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■3 [Point/Line Attribute] tab

Set the status of points or lines of the graph corresponding to the device value.
For the conditions, refer to the following.

➟6.5.5 ■2 Setting conditions

1) [Attribute Switching]
Select the switching type in which the display attribute of the scatter graph (type of points and lines, size, or color) 
is switched.
The following shows the items to be selected.

• [Fixed]:
The display attribute is not switched.
Points or lines are displayed in the display attribute set in the [Style] tab.

• [Bit]:
Switches two types of the display attribute according to the bit device status.

• [Signed BIN16]:
Switches multiple display attributes by the value of the word device (16-bit binary value).

• [Signed BIN8]:
Switches multiple display attributes with eight bit devices.

• [BCD16]:
Switches multiple display attributes by the value of the word device (16-bit BCD value).

[Display the graph frame]

Select this item to display the frame of the graph.

Item Description

Graph frame

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)

1)

10)
8)

9)

5) 6) 7)

2)
3)

11)
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Example 1)
• [Attribute Switching]: [Bit]
• [Switching Device]: [M10]

Example 2)
• [Attribute Switching]: [Signed BIN16]
• [Switching Device]: [D10]

2) [Switching Device]
Set the display switching device.

➟6.1.2 How to set devices
3) [Display Attribute]

Select the display attribute of the scatter graph.
The following shows the items to be selected.

• [Point]
• [Line]

4) [Number of States]
The number of the set conditions

5) Add button
Adds a new condition.

6) Delete button
Deletes the selected condition.

7) Up button, down button
Changes the order of priority of the selected condition.

8) Preview list
Displays set conditions.

9) [Utilize] button
Creates a new condition utilizing the selected condition.

10) [Attribute]
Set the attributes of points or lines.

• For points

• [Style]
Select the style of the point.
The following shows the items to be selected.

• [Size]
Select the size of the point.
The following shows the items to be selected.
·[Small]
·[Medium]
·[Large]

• [Color]
Set the color of the point.

M10: ON M10: OFF
The points are 
displayed in ●.

The point are 
displayed in ▲.

D10 < 100D10 = 10D10 = 1
The points are 
displayed in ●.

The point are 
displayed in ▲.

The points are 
displayed in ■.

,             ,                ,               ,               ,             ,                , 
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• For lines

11) [Range]

■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

• [Style]
Select the style of the line.
The following shows the items to be selected.
·Solid line
·Dotted line
·Broken line
·One-dot chain line
·Two-dot chain line

• [Size]
Select the width of the line.
The following shows the items to be selected.
·[1 Dot]
·[2 Dot]
·[3 Dot]
·[4 Dot]
·[5 Dot]
·[7 Dot]

• [Color]
Select the color of the line.

Item Description

[Range]

Set the display range of the conditions selected in the preview list.
When setting the value of the word device as the condition, click the [Range] button to 
display the [Edit Range] dialog, and then set the conditional expression.
➟6.5.5 ■2 Setting conditions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

9)

7)

8)

6)
5)

4)

3)
2)
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2) [Use offset]
Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
If this item is set, [Store Memory] cannot be set.

3) [Store Memory]
Select this item to continue data collection while a screen which displays no scatter graph is displayed.
The data of the points displayed on the graph is stored to the internal memory of the GOT.

➟8.20.2 ■3 Memory storage
If this item is set, [Use Offset] cannot be set.

4) [Hidden Value]
Select this item to hide a specific value in the scatter graph for each of X-axis and Y-axis.
Example) [Hidden Value] is set to 0 for both of X-axis and Y-axis.

5) [Cumulative/Average]
Select this item to write the cumulative count and average value, maximum value, and minimum value of the 
collected data to devices.

➟8.20.2 ■4 Writing the cumulative count and average value
After selecting this item, set the interval of writing the cumulative count, average value, maximum value, and 
minimum value to devices.
The setting range is [1] time to [36000] times.
The value set in [Hidden Value] is not included in the cumulative count, average value, maximum value, and 
minimum value.
If the cumulative count, average value, maximum value, or minimum value is being written, the display of the object 
may be delayed when short intervals are set as the condition for the data storage or display.

6) [Device (7 devices)]
Set the device to be used for [Cumulative/Average].
Seven successive devices are automatically set from the specified device.

7) [Operation at frequency over time]
Select the operation that is executed when the number of displays of the memory storage or the number of data 
collections exceeds the limit.
For the limit, refer to the following.

➟8.20.2 ■3 (1) Maximum number of displayed points that can be saved to the memory
　 8.20.2 ■4 (1) Maximum number of collections that can be counted in the cumulative count or average 
value
　 8.20.2 ■4 (3) When the cumulative count and average value are written and the memory storage are used 
simultaneously

The following shows the items to be selected.
• [Interrupt]:

Data collection is interrupted and the display of the graph is not refreshed.
• [Initialize and Continue]:

After the display of the graph is deleted and the memory storage, cumulative count, average value, maximum 
value, and minimum value are initialized, the data collection resumes.

8) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

400

300

200

100

  0
100  0 200 300

Hidden value
(0, 400)
(50, 0)

When the display attribute 
is set to "point"

400

300

200

100

  0
100  0 200 300

Hidden value
(0, 400)
(50, 0)

When the display attribute 
is set to "line"
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9) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control Displaying/Hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)

4)
5)
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3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

4) [Clear Trigger]
Select this item to use the trigger that clears the display of the graph.
After setting this item, select the clear timing of the display of the graph.
The following shows the items to be selected.

• [Rise]: The display is cleared at the rise of the bit device (OFF → ON).
• [Fall]: The display is cleared at the fall of the bit device (ON → OFF).

[Clear Trigger] clears the display of the graph, cumulative count, and average value stored in the memory.
5) [Clear Trigger Device]

Set a device used for the clear trigger.

■6 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]

Item Description

[Collect data only when trigger conditions are 
satisfied]

Select this item to collect data only when the trigger set for [Trigger Type] is satisfied.
When [Rise], [Fall], [Rise/Fall], [Sampling], [ON Sampling], or [OFF Sampling] is selected, 
this setting is available.
The graph is communicating with the controller even when the trigger is off.
To reduce the load of the communication between the GOT and controller, allow the 
communication when the trigger is on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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• [Script]
Set the expression used for the script function.

➟(2) [Script]

(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
8. OBJECT FUNCTION
8.20 Placing a Scatter Graph

8 - 573



*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
*3 When GOT Graphic Ver.1 is selected and [Graph Type] is [Sample] or [Batch], the timing for reflecting the setting change 

depends on the selection for [Display Mode].
[Locus]: When the screen is updated
[Replace]: When the object is updated
When GOT Graphic Ver.2 is selected, the setting change is reflected when the objected is updated regardless of the graph 
type.

8.20.5 Relevant settings

Set the relevant settings other than the specific settings for the scatter graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

[Data]

[Lower Limit] (X) scale_min[0] ○ ○ When the object is 
updated

*3

[Lower Limit] (Y) scale_min[1] ○ ○ When the object is 
updated

*3

[Upper Limit] (X) scale_max[0] ○ ○ When the object is 
updated

*3

[Upper Limit] (Y) scale_max[1] ○ ○ When the object is 
updated

*3

[Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the object is 
updated

*3

[Point/Line 
Attribute] [Color] graph_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.21 Placing a Historical Trend Graph

This function displays the device data collected by logging in chronological order in a trend graph.

8.21.1 Specifications of the historical trend graph

The following shows the specifications of the historical trend graph.

■1 Number of trend graphs that can be set
(1) Maximum number of historical trend graphs on one screen

The maximum number of objects on one screen depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 32 trend graphs and/or historical trend graphs can be placed on one screen.
• For GT21 and GS21

One historical data list display, trend graph, scatter graph, or historical trend graph can be placed on one screen.

(2) Maximum number of lines in one historical trend graph
The maximum number of lines in one historical trend graph depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 32 lines are displayable in one graph.

• For GT21 and GS21
Up to four lines are displayable in one graph.

(3) Maximum number of points
The maximum number of points on one line of a historical trend graph depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 1024 points are displayable.

• For GT21 and GS21
Up to 500 points are displayable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Displays past data.Usually displays 
a trend graph.

Displays the latest data.

Data collected 
by logging

Graph display range Graph display range Graph display range

Refresh Refresh Refresh

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Relation between the historical trend graph and logging
The data collected and stored in the buffering area or memory card by logging is displayed in a graph.

➟9.2 Collecting Device Data ([Logging])
The stored data is used, enabling display of both the latest and old data in a graph.

A historical trend graph displays only the data of one logging ID.
To display the data of multiple logging IDs, set multiple historical trend graphs.

■3 Difference from the trend graph
The trend graph collects data and displays it.
The trend graph does not require the setting of logging, and the data is not stored.

➟8.16 Placing a Trend Graph

■4 Useful function
The following explains the useful functions for using the historical trend graph.

(1) Displaying a cursor
A cursor can be displayed and moved on the graph using the touch switch to which the key code is assigned.
With the setting of the single touch operation, the cursor can be displayed on or moved to the touched position directly.
The device value of the position where the cursor is displayed can be output to the device set in the [Graph Information] 
dialog.
While a cursor is displayed, the display of the graph stops.

(2) Displaying grids
Grids can be displayed on a graph.

(3) Displaying a reference line, lower limit lime, and upper limit line
A reference line, lower limit lime, and upper limit line can be displayed on a graph.

01: 100
02: 144
03: 189
04: 212
05: 238
06: 288
    :
20: 448

Logging data

Displays accumulated data in a graph.

D100
D120

258
231

D100

D120

Without grids With grids

None Enabled

Reference line

Upper limit line

Lower limit line
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(4) Enlarging or reducing the time axis
The time axis can be enlarged or reduced by using the touch switch to which the key code is assigned.

(a) Data displayed upon enlargement or reduction
When enlarging or reducing the time axis, you can select whether to always display the latest data or stop the graph 
update to display the current data.

(b) Displaying the magnification
You can store the magnification factor being used to a specific device.
Thus, the current magnification is displayable with the numerical display.

(5) Magnification for displaying the latest data
When the latest data is displayed with the touch switch, screen switching, or graph offset function, you can specify a 
magnification factor to display the data.
Example) When [Graph display magnification for latest data display] is set to [2-fold]

(6) External output of date data
When [Always update Beginning Position Time/End Position Time] in the [Extended] tab is set, the latest beginning 
position time and end position time can be output constantly to the Time device.
The beginning position time, end position time, and cursor position time can be output to the Time device by using the 
touch switch to which the key code is assigned.
While the data is output to the device, the display of the graph stops.

(7) Displaying data obtained at specified time
The data obtained at specified time can be displayed by using the touch switch to which the key code is assigned.
While the data obtained at specified time is displayed, the display of the graph stops.

(8) Displaying data of historical trend graphs in historical data list displays
Not available to GT21 and GS21.
The data displayed with a cursor in a historical trend graph can be displayed in a historical data list display.

➟8.10 Placing a Historical Data List Display

2015 25 3020151050 25 30

Enlarge

Reduce

0

50

100

50

Display magnification: 
2-fold

0 100
0

50

100

75 10050

Update 
the graph

Original magnification Enlarged at 2-fold magnification

21:0019:00 23:00

Beginning position time End position timeCursor position time

Time to be specified

Jun. 29, 2013 21:05:30

The data obtained at the specified time 
can be displayed in the center of the list.
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(9) Holding the graph display state displayed before screen switching
The GOT holds the display state of the historical trend graph displayed before screen switching and displays the same 
graph state after switching back to the graph screen.
Before using this setting, set the Logging Count device.

➟9.2 Collecting Device Data ([Logging])
Use the Historical Trend Graph Display Mode signal (GS450.b9) to set the historical trend graph display mode.

• ON: Holds the display state displayed before screen switching.
• OFF: Not hold the display state displayed before screen switching.

The GOT checks this signal every screen switching.

(a) Action at screen switching
If a screen is switched while GS450.b9 is on, the GOT operates as follows.

• Screen on which the historical trend graph is displayed → another screen
The GOT holds the display state of the historical trend graph.

• Other screens → screen on which the historical trend graph is displayed
The GOT restores and displays the previous historical trend graph based on the held data.
When the amount of the logging data has increased since the first screen switching, the increased logging data is 
added to the graph.
If holding no data, the GOT displays the latest logging data.

Back
200

Screen 
switching

Base screen 2Base screen 1
The state before 
screen switching 
is held.

Screen Switching

The logging data to which 
the data collected after 
the first screen switching 
has been added is displayed.

Point of switching 
back to base screen 1

Graph display range

Base screen 1

Back
200

Base screen 2

Page 1 Page 2 ... Logging data after 
screen switching

Held 
data
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(b) Action example
The following shows an example of the following action: base screen 1 (on which a historical trend graph is placed) is 
switched to base screen 2, and then base screen 1 is displayed again.
Example)

• When GS450.b9 is on (displaying the latest data)
After the logging data that has been collected after the screen is switched is added to the held data, the logging data 
is displayed.

• When GS450.b9 is on (displaying the past data)
The state before the screen is switched is displayed.
The logging data that has been collected after the screen is switched is not displayed.

• When GS450.b9 is off
The logging data after base screen 1 is displayed again is displayed.

Graph display range

Back
200

Screen 
switching

Screen 
switching

Point of switching 
back to base screen 1

Base screen 2Base screen 1 Base screen 1

Graph display range

Page 1 Page 2 ... Page 1 Page 2 ... Logging data added 
after screen switching

The logging data to which 
the data collected after 
the first screen switching 
has been added is displayed.

Graph display range

Back
200

Screen 
switching

Screen 
switching

Base screen 2Base screen 1 Base screen 1

Graph display range

Page 1 Page 2 ... Page 1 Page 2 ... The logging data that has 
been collected after screen 
switching is not displayed.

The state before screen 
switching is displayed 
from the held data.

Graph display range Graph display range

Back
200

Screen 
switching

Screen 
switching

Point of switching 
back to base screen 1

Page 1 Page 2 ...

Base screen 2Base screen 1 Base screen 1

Page 1 Page 2 ...

The logging data after 
base screen 1 is displayed 
again is displayed.
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(c) Restrictions
When the logging ID to be monitored by the historical trend graph is set using a device, pay attention when changing the 
logging ID.
If the logging ID to be monitored is changed after the display state is held, the display state is discarded.
Even when the screen is returned to the screen on which the historical trend graph is placed, the state before the screen 
switching is not restored and the latest logging data is displayed.

■5 Touch switch for the historical trend graph
Touch switches for the historical trend graph are available by reading them from the library of GT Designer3.
The characters and shapes on the touch switches can be changed by a user.
When key codes are set for touch switches, touch switches for the historical trend graph can be created by a user.

Touch switch Key code Description

Show cursor

FFF0h

Displays or deletes the cursor.
Displays the cursor in the center of the graph.

Hide cursor

FFF1h

Graph Cursor Next

FFF2h

Moves the cursor to the new or past data.
Example) When [Display Mode] is set to [Pen Record] and [Direction] is set to [Right]

Graph Cursor Previous

FFF3h

Touch switch for the historical trend graph

0

50

100
75

25

20151050 25 30 20151050 25 30
The cursor is shown.

0

50

100
75

25

The cursor moves 
to the old data.

20151050 25 30

Old

20151050 25 30
The cursor moves 
to the latest data.Latest

20151050 25 30
0

50

100
75

25

20151050 25 30
0

50

100
75

25

0

50

100
75

25

0

50

100
75

25
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Graph Next

FFF4h

Scrolls the graph right or left. 
Example) When [Display Mode] is set to [Pen Record] and [Direction] is set to [Right]

Graph Previous

FFF5h

Graph Next Page Scroll

FFF6h

Moves the graph right or left in units of page. 
Example) When [Display Mode] is set to [Pen Record] and [Direction] is set to [Right]

Graph Previous Page Scroll

FFF7h

Time Axis Expansion

FFF8h

Enlarges or reduces the time axis by using the axis of new data as the reference.
You can enlarge the time axis until the graph displays two points.
The scope of reducing the time axis varies with the setting of [Shrink the graph to be less than its full 
scale].
• [When [Shrink the graph to be less than its full scale] is selected

The time axis can be reduced to a magnification of 1/128.
• When [Shrink the graph to be less than its full scale] is deselected

The time axis can be reduced to the original magnification.
For the setting of [Shrink the graph to be less than its full scale], refer to the following.

➟8.21.4 ■4 [Extended] tab

Time Axis Reduction

FFF9h

Latest data

FFEFh

Displays the latest data.

Touch switch Key code Description

20151050 25 30
0

50

100
75

25
0

50

100
75

25

20151050 25 30
The graph scrolls to 
the latest data.Latest

0

50

100
75

25
0

50

100
75

25

20151050 25 30 20151050 25 30
The graph is scrolled to 
the latest data in units of page.

Latest

0

50

100
75

25
0

50

100
75

25

2015 25 30

Base

20151050 25 30

0

50

100
75

25
0

50

100
75

25

20151050 25 30 20151050 25 30
Displays the latest data.
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Move display position to the 
specified time

FFD4h

Displays the date data stored in the Display Position Time Specification device in the center.
(Time specification jump function)
Using the time specification jump function may change the graph display magnification as shown 
below.
• When a graph has been enlarged from the original magnification

The graph display magnification returns to the original magnification after this function is used.
• When a graph has been reduced from the original magnification

The graph display magnification remains unchanged after this function is used.

Touch switch Key code Description

20151050 25 30 20151050 25 30

Time to be specified
Nov. 12, 2008 21:05:30 The data obtained at the specified 

time can be displayed in the center 
of the list.

0

50

100
75

25
0

50

100
75

25
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8.21.2 How to use the historical graph

The following shows how to use the historical trend graph.

■1 Setting logging
To use a historical trend graph, the logging setting is required.

➟9.2 Collecting Device Data ([Logging])

■2 Placing the historical trend graph
The following shows how to place the historical trend graph.

Step 1 Select [Object] → [Graph] → [Historical Trend Graph] from the menu.
Step 2 Click the position where you place the scatter graph. Placing the scatter graph is complete.
Step 3 Adjust the frame size of the historical trend graph.
Step 4 Double-click the placed scatter graph to display the setting dialog.

➟8.21.4 [Historical Trend Graph] dialog
Step 5 Display the [Data] tab.

➟8.21.4 ■1 [Data] tab
Step 6 Set the number of lines and points to be displayed in the historical trend graph.

Step 7 Set a device to be monitored.

➟6.1.2 How to set devices
Step 8 Set [Lower Limit] and [Upper Limit].
Step 9 Set the scale and figure in the [Style] tab.

➟8.21.4 ■2 [Style] tab

Step 10 Set the graph assistance line and cursor attribute in the [Auxiliary Line/Cursor] tab.

➟8.21.4 ■3 [Auxiliary Line/Cursor] tab

Step 11 Click the [OK] button to complete the historical trend graph settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display direction (right)

Lower limit, upper limit
(lower limit: 0, upper limit: 1000)

1000

0

Number of lines (2 lines)

Number of points (6 points)

Monitored device (D10, D11)

Scale
 Y (number of lines: 5)
 X (number of points: 7)

100

0

50

0 50 100
Scale value
 Y (number of scale values: 3)
 X (number of scale values: 3)

Figure1000

0

1000

0

100

0

50

0 50 100

Reference line

Cursor
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■3 Identifying multiple objects (setting user IDs)
When multiple objects that are operated by the touch switch to which the key codes are assigned are placed on one 
screen, touching the touch switch may operate the object that is not the target.
Setting a user ID limits the objects operated when the touch switch is touched.

The following shows the setting procedure.

(1) Setting of the historical trend graph
Step 1 Double-click the historical trend graph placed on the screen editor.

The [Historical Trend Graph] dialog appears.
➟8.21.4 [Historical Trend Graph] dialog

Step 2 Enable [User ID] in the [Extended] tab, and specify the number.

➟8.21.4 ■4 [Extended] tab
The number is used to define the target object as the object that operates when the touch switch is touched.
Do not set [User ID] that is already used for other objects.

(2) Settings of touch switches
Step 1 Display the [Switch] dialog.

For the details of the switch, refer to the following.
➟8.2 Placing a Touch Switch

Step 2 Click the [Key Code] button in the [Action] tab.
Step 3 Enable [Individually set user ID for a key input] and specify a number.

Set the same number as the number specified in [User ID] of [Historical Trend Graph].

■4 Storing graph data in devices
The following values displayed in each graph can be stored in devices.

• Value at the cursor
• Maximum value
• Minimum value
• Average value

Even though data operation is set, the value before the data operation is stored.

(1) How to store the data in devices
Set the devices to store the values in [Graph Information] in the [Data] tab.
Set the devices and select the options of data you want to collect.

➟8.21.4 ■1 [Data] tab

Touch switch for 
historical trend graph A

Touch switch for 
historical trend graph B

Historical trend graph B

20151050 25 30
0

25

50
0 3 6 9 12 15 18 21 24

0

300

500
400

200

Historical trend graph A

Show cursor

Hide cursor

Refresh

Show cursor

Hide cursor

Upward Downward

Check Deleting 
a project

20151050 25 30
0

25

50
0 3 6 9 12 15 18 21 24

0

300

500
400

200

Historical trend graph A

Show cursor

Hide cursor

Refresh

Touch switch for 
historical trend graph A

(User ID: 2)(User ID: 1)

(User ID: 2)(User ID: 1)

When no user ID is set When the user ID is set

The touch switches for historical trend graph A 
operate for historical trend graph B.

Although the same key codes are used, the target 
for an operation can be specified with ID numbers. 
Hence operations can be performed as required.

Show cursor

Hide cursor

Refresh

1050
0

100

Touch switch for 
historical trend graph B

1050
0

100

Historical trend graph B
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(2) Timing with which values are stored in the devices
The timing depends on the model.
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Values are stored to the devices at the following timings.

• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

GT21 and GS21
The value at the cursor is stored to the device at the following timings.

• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

The maximum, minimum, and average values are constantly acquired and stored to the devices.

Example) Storing the value at the cursor, maximum value, and minimum value in GT27

Example) Storing the value at the cursor, maximum value, and minimum value in GT21

■5 Storing date data in devices
The time of the cursor display position, display range beginning position, and display range end position of the graph can 
be stored to the device by using the Time device.

(1) How to store the data to the device
Data is stored in the upper eight bits and lower eight bits of set devices.
Numerical values are stored in BCD.
Example) When [Device] is set to [D100]

Display the cursor

(Time)

Values acquired and stored 
in the devices

Cursor: 50
Max. value: 100
Min. value: 0

Cursor: 0
Max. value: 0
Min. value: 0

The graph is updated.
The cursor is deleted.

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values are reset after 
the update.

Cursor: 75
Max. value: 75
Min. value: 25

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values acquired and stored 
in the devices

75
50
25

0
0 5 10 15 20 25 30

100
(Value) Display the cursor

75
50
25

0
0 5 10 15 20 25 30

100
(Value) Display the cursor Display the cursor

(Time)

The graph is updated.
The cursor is deleted.

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

(Time)

75
50
25

0
0 5 10 15 20 25 30

100
(Value)

Values acquired and stored 
in the devices

Value at the cursor: 
Reset after the update.
Max. and min. values: 
Acquired and stored in the devices 
after the update.

Value at the cursor: 
Acquired and stored in the device.
Max. and min. values: 
No change. Retained.

Cursor: 50
Max. value: 100
Min. value: 0

Cursor: 0
Max. value: 75
Min. value: 25

Cursor: 75
Max. value: 75
Min. value: 25

Item Device Description

[yymm] D100
• b15 to b8: The year is stored.
• b7 to b0: The month is stored.

[ddhh] D101
• b15 to b8: The day is stored.
• b7 to b0: The time (hour) is stored.
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(2) Storage timing and values stored to devices
(a) Timing when the value is stored

With the following timings, values are stored to devices.
• When a cursor is displayed on a graph
• When a cursor is moved
• When a historical trend graph is operated with a touch switch with a cursor displayed

(b) Values to be stored
When a cursor is displayed on the graph, the drawing processing of the graph stops.
The values at the stop of the draw processing are stored to devices.

(3) Displaying date data in the numerical display
Date data can be displayed in the numerical display.
The following shows the setting procedure.

Step 1 Display the setting dialog for the placed numerical display ([Numerical Display] dialog).
For the details of the numerical display, refer to the following.

➟8.4 Placing a Numerical Display and Numerical Input
Step 2 Select [BCD16], [BCD32], or [BCD64] in [Data Type] in the [Device] tab.
Step 3 Set the mask processing and shift processing in the [Operation/Script] tab.

• When displaying upper 8 bits (year)

• When displaying lower 8 bits (month)

[mmss] D102
• b15 to b8: The time (minute) is stored.
• b7 to b0: The time (second) is stored.

[Day] D103

• b15 to b8: None
• b7 to b0:

The day of the week is stored as a numerical value.
The following shows the numerical values 
corresponding to the days.
• 0: Sunday
• 1: Monday
• 2: Tuesday
• 3: Wednesday
• 4: Thursday
• 5: Friday
• 6: Saturday

Item Device Description

20151050 25 30
0

50

100

25

75

Show the cursor

20151050 25 30
0

50

100

25

75

Move the cursor

Stores the time displayed 
where the cursor is placed.

Stores the time displayed 
where the cursor is placed.

Data displayed where the cursor is placed 
at the instant when a draw processing 
stops is stored with the timing that 
the cursor is displayed/moved.

Example) Storing a time in the device

In the numerical display, set the lower 8 bits of D100 (b7 to b0) to be masked 
and the upper 8 bits of D100 (b15 to b8) to be shifted to the right by 8 bits.
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■6 Displaying the data obtained at specified time in the center (time specification jump 
function)

By using the display position time device and a touch switch, the data obtained at specified time can be displayed in the 
center of the historical trend graph.
When no data is obtained at the specified time, the data which has the nearest specified date is displayed.
When the multiple values are obtained at the nearest time, the first detected value is displayed.

(1) How to store the data to the device
Set a device to store the data in the upper eight bits and lower eight bits.
Numerical values are stored in BCD16.
Example) When [Device] is set to [D100]

(2) Setting procedure
(a) Settings of touch switches

To use time specification jump function, the following touch switches are required.
• Touch switch for displaying the specified time
• Touch switch for restarting the drawing processing of the graph

If the time specification jump function is used, the drawing processing of the graph stops.
A touch switch for restarting the drawing processing of the graph is required.
The following shows the setting procedure.

Step 1 Display the setting dialog for the placed switch ([Switch] dialog).
For the details of the switch, refer to the following.

➟8.2 Placing a Touch Switch
Step 2 Click the [Key Code] button in the [Action] tab.
Step 3 Set the key cord according to the touch switch to be created.

• When setting a touch switch for displaying the specified time
Set [Code Setting] to [FFD4].

• When setting a touch switch for restarting the drawing processing of the graph
Set [Code Setting] to [FFEF].

Using the library data
Touch switches are registered in the library.
➟8.1 Using Objects in the Library

In the numerical display, set the upper 8 bits of D100 (b15 to b8) to be masked.

Item Device Description

[yymm] D100
• b15 to b8: The year is stored.
• b7 to b0: The month is stored.

[ddhh] D101
• b15 to b8: The day is stored.
• b7 to b0: The time (hour) is stored.

[Minute/Second] D102
• b15 to b8: The time (minute) is stored.
• b7 to b0: The time (second) is stored.
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(b) Setting of the historical trend graph
Step 1 Double-click the historical trend graph placed on the screen editor.

The [Historical Trend Graph] dialog appears.
➟8.21.4 [Historical Trend Graph] dialog

Step 2 Enable [Display Position Time] in the [Extended] tab, and specify a device.

➟8.21.4 ■4 [Extended] tab

(3) Operation example
The following shows the operation examples.
Example) When setting [D1000] in [Display Position Time Device] and displaying the data of Jun.29, 2013 21:05:30

(4) Precautions
(a) When date data is being searched for

When date data is being searched for, the historical trend graph cannot be operated.

(b) When no data can be displayed on the historical trend graph
When no data can be displayed on the historical trend graph, the time specification jump function is not executed.

(c) When displaying the data displayed near the start or end point
If the data obtained at specified time is near the start or end point, it may not be displayed in the center of the graph.

(d) Using the time specification jump function for an enlarged or reduced graph
Using the time specification jump function may change the graph display magnification as shown below.

• When a graph has been enlarged from the original magnification
The graph display magnification returns to the original magnification after this function is used.

• When a graph has been reduced from the original magnification
The graph display magnification remains unchanged after this function is used.

■7 Operations performed using the object gesture function
Not available to GT21 and GS21.
The display of objects can be operated using gestures.
For operations with gestures, refer to the following.

➟11.13 Operating Objects by the Gesture (Object Gesture Function)

Display Position Time device

Set the time to be displayed in 
the Display Position Time device.

Year and month 
(D1000)

b15

0x13

0x29

0x05

0x06

0x21

0x30

b0

Day and time 
(D1001)
Minute and 
second (D1002)

Time 
specification
jump

The data obtained at the specified time 
(Jun. 29, 2013 21:5:30) can be 
displayed in the center of the list.

Touch the touch switch 
for which the key code 
(FFD4h) has been set.
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8.21.3 Precautions for a historical trend graph

The following shows the precautions for the historical trend graph.

■1 When the monitored device value exceeds the upper or lower limit value
The trend graph does not display a device value that is above the upper limit or below the lower limit.
In such a case, the upper or lower limit symbol appears at the position where the device value is hidden from view.

To hide the upper and lower limit symbols, turn on GS450.b10.
➟12.1.3 GOT special register (GS)

■2 When the device type is set to the string in a logging setting
When [Device Type] is set to [String] in a logging setting, a system alarm occurs and the graph using the setting is not 
displayed.
(Not available to GT21 and GS21)

■3 When a graph is reduced from the original magnification
(1) Data displayed on the graph

If a graph is reduced from the original magnification, some pieces of data are thinned out and do not appear on the graph. 
Thus, the data displayed on the graph before and after the reduction may differ.
To check specific data on a graph, display the graph at the original magnification or greater.

(2) Elapsed time before a graph appears
If a graph is reduced from the original magnification, the graph may take a long time to appear.
In such a case, enlarge the graph close to the original magnification.

(3) Storing the maximum value, minimum value, and average value of a graph to specific devices
If a graph is reduced from the original magnification, some pieces of data are thinned out and do not appear on the graph. 
The maximum value, minimum value, and average value of the reduced graph are stored to specific devices.
Thus, the actual maximum value, minimum value, and average value of the graph at the original magnification may not 
be stored.
Before storing the values, enlarge the graph to the original magnification.

■4 Precautions for drawing
If you place a historical trend graph by using the [Create a new historical trend graph] button in the [Logging] dialog, the 
settings of the following items in the [Options] dialog are not applied.

• Place figures/objects sequentially
• Deselect figures/objects once they are placed
• Display the setting dialog once figures/objects are placed

➟9.2.6 [Logging] dialog
11.10.4 Customizing the settings related to editing operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Upper limit value: 1000

Upper and lower limit symbols

D10: 1200

D10: -400

Lower limit value: 0
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8.21.4 [Historical Trend Graph] dialog

The historical trend graph is an object that constantly collects data in word devices and display it in a graph.
Step 1 Select [Object] → [Graph] → [Historical Trend Graph] from the menu.
Step 2 Click the position where you place the historical trend graph. Placing the historical trend graph is complete.
Step 3 Double-click the historical trend graph display which has been placed to display the setting dialog.

➟■1 [Data] tab
■2 [Style] tab
■3 [Auxiliary Line/Cursor] tab
■4 [Extended] tab
■5 [External Output] tab
■6 [Trigger] tab
■7 [Operation/Script] tab

■1 [Data] tab

Set the device to be monitored and the historical trend graph status corresponding to the device value.

1) [Graph Type]
Select the graph to be set.
The following shows the items to be selected.

• [Trend Graph]
• [Historical Trend Graph]

2) [Display Format]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Number of Pens]

Set the number of lines to be displayed in the historical trend graph.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

The setting range is [1] to [32].
• For GT21 and GS21

The setting range is [1] to [4].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4)

2)
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[Points]

Set the number of points to be displayed on a line of the historical trend graph.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

The setting range is [2] to [1024].
• For GT21 and GS21

The setting range is [2] to [500].

Depending on the number of points and X-axis display range, the interval between points is adjusted 
automatically.

[Direction]

Select the display direction of the graph.
The following shows the items to be selected.
• [Up]
• [Right]
• [Down]
• [Left]

[Display Mode]

The following shows how to draw the historical trend graph.
The following shows the items to be selected.
• [Pen Record]:

The line of the graph is drawn by moving the whole graph to [Direction].
The point indicating the latest value is always drawn at the graph edge.

• [One by One]
The current value is displayed in the display direction.When the graph is drawn fully in a display range, the 
graph being displayed is cleared and a new graph is drawn.

• [Next Point Movement]
The line of the graph is drawn to [Direction].
The point indicating the latest value moves to the display direction.
Once the point indicating the latest value reaches to the graph edge, the point is drawn at the graph edge 
constantly.

Item Description

Point interval = 20 dots

Example)
Number of points: 5

X-axis 100 dots

(Display direction: Right)

Graph edge

Latest value

Time flow Time flow

Current value Current value Current value

Display flow

Time flow
(Display direction: Right)

Latest value

Time flow

Latest value

Graph edge
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3) [Device]

[Point Type]

Select the point type.
The following shows the items to be selected.
• [Line]
• [Point]
• [Line + Point]

Item Description

[Logging ID]

Set the logging ID with which the data to be displayed on the historical trend graph is collected.
Select whether to specify the ID using a fixed value or device value.
The following shows the items to be selected.
• [Fixed]:

Specify the ID directly.
You can select ID from the logging name as well.

• [Device]:
Specify the value of the word device as a logging ID.

➟6.1.2 How to set devices

[Device Setting]
Select how to set the device.
The following shows the items to be selected.
• [Continuous]: When a start device is set, inputs consecutive devices automatically in the table of [Device].
• [Random]: Select this item when setting devices one by one.

[Use Graph Offset]

Select this item to monitor the logging device that is set in the logging ID and specified by the value of the 
offset device.
When a graph has multiple lines, the device to be monitored differs depending on the set value in [Device 
Setting]. After checking the device value, set the offset device.
Example) When [Number of Pens] is set to [2] and offset device is set to [3]

[No. Logging Device]

In the [Device List] dialog, select a logging device of a selected logging ID number.
After the selection in the [Device List] dialog, the logging devices equivalent to the setting of [Number of Pens] 
are set.
Example) When [Number of Pens] is set to [3]

[Data Operation]

Set this item to execute the data operation.

➟6.5.5 ■4 (3) [Edit Data Expression] dialog
The setting of [Data Type] in the [Historical Trend Graph] dialog is applied to the data type of the device set 
for the expression of this item.

Item Description

[Line] [Point] [Line + Point]

Logging device

No. 1 D100 (0)

No. 7 D203 (sixth)
No. 6 D201 (fifth)
No. 5 D200 (fourth)

No. 3 D102 (second)
No. 2 D101 (first)

• Device setting: Continuous

The third device from 
the selected device 
and one subsequent 
device are monitored.

• Device setting: Random (Select No.1 or No.5.)

No. 8 D204 (seventh)

No. 4 D103 (third)
The third devices 
from each selected 
device are monitored.

Logging device
No. 1 D100 (0)

No. 7 D203 (second)
No. 6 D201 (first)
No. 5 D200 (0)

No. 3 D102 (second)
No. 2 D101 (first)

No. 8 D204 (third)

No. 4 D103 (third)

Selected device

Selected device

Logging device No.
Logging device
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[Line Attribute]

Set the attribute of the line.
When [Line] or [Line + Point] is selected for [Point Type], set this item.

• [Line Style]
Select the style of the line.
The following shows the items to be selected.
· Solid line
· Dotted line
· Broken line
· One-dot chain line
· Two-dot chain line

• [Width]
Select the width of the line.
The following shows the items to be selected.
· [1 Dot]
· [2 Dot]
· [3 Dot]
· [4 Dot]
· [5 Dot]
· [7 Dot]

• [Line Color]
Select the color of the line.

[Point Attribute]

Set the attribute of the points.
When [Point] or [Line + Point] is selected for [Point Type], set this item.

• [Type]
Select the style of the point.
The following shows the items to be selected.

• [Size]
Select the size of the point.
The following shows the items to be selected.
· [Large]: 9 dots
· [Medium]: 7 dots
· [Small]: 5 dots
· [Very small]: 3 dots
· [Point]: 1 dot
Only when [0] is selected for [Type], [Very small] or [Point] can be selected.

• [Color]
Set the color of the point.

Item Description

  0:        ,   1:        ,   2:       ,   3:       ,   4:        ,   5:

  6:        ,   7:       ,    8:       ,   9:       , 10:       , 11:

12:        , 13:       , 14:       , 15: 
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[Graph Information]

Set the device in which the information displayed on the graph is stored or device that clears the line of the 
graph.
For the timings with which values are stored in the devices set for [Maximum Data], [Minimum Data], and 
[Average Data], refer to the following.

➟8.21.2 ■4 Storing graph data in devices

• [Device Data Storage]
Set the device in which the graph information is stored.
The successive devices following the device set in this item are assigned automatically to [Cursor Position 
Data] or later items.
Set each item optionally.
The device is assigned only to the set item.
Using the GOT internal device is recommended for this setting.
Even though data operation is set, the value before the data operation is stored.

• [Data Type]
Select the data type of the word device in which graph information is stored.
Select the same data type as that of the logging device.
When the data type of the logging device is bit, select [Signed BIN16], [Unsigned BIN16], or [BCD16].
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

• [Cursor Position Data]
Select this item to store the value of device positioned by the cursor.
The device is assigned automatically.

• [Maximum Data]
Select this item to store the maximum value of the device values displayed on the graph is to be stored.
The device is assigned automatically.

• [Minimum Data]
Select this item to store the minimum value of the device values displayed on the graph.
The device is assigned automatically.

• [Average Data]
Select this item to store the average value of the device values displayed on the graph.
The device is assigned automatically.

• [Graph Line External Control]
· [Graph Line Clear Device]
Select this item to clear the line of the graph using a device.
After selecting this item, set the device.

[Step Mode]

Select this item to display the line of the trend graph by steps.

Item Description

Displayed by no steps Displayed by steps
8 - 594 8. OBJECT FUNCTION
8.21 Placing a Historical Trend Graph



8

O
B

JE
C

T 
FU

N
C

TI
O

N

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Data Type]

Select the data type of the word device.
The following shows the items to be selected.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

When the device data type is signed 64-bit binary, unsigned 64-bit binary, 64-bit binary-coded decimal, or real 
number (64 bits), select one of the following.
Selecting a data type other than the following may disable proper data operation.
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD64]
• [Real(64bit)]

[Lower Limit], [Upper Limit]

Select whether to specify the display range (lower and upper limit values) of the trend graph with the fixed 
value or with the device value.
The following shows the items to be selected.
• [Fixed]:

Specify a constant.
• [Device]:

Specify a device value.

➟6.1.2 How to set devices

The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].

Item Description
8. OBJECT FUNCTION
8.21 Placing a Historical Trend Graph

8 - 595



■2 [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Scale Settings]
Displays the line or scale value in the historical trend graph.

Item Description

[Axis Position]

Select the position where the line or scale value is displayed.
The following shows the items to be selected.
• [Left] button
• [Right] button
• [Top] button
• [Bottom] button
After selecting the position, set the line or scale value.

[Main Scale]

Set this item to display lines on the scale.

• [Color]
Set the color of lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [101].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2)
3)

Line
(X: 5)
(Y: 5)

Scale value
(X: 3)
(Y: 3)

Displays both the lines 
and scale values.
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500 100
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0
500 100
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[Sub Scale]

Set this item to place lines between the lines set in [Main Scale].

• [Color]
Set the color of sub lines on the scale.

• [Scale Points]
Set the number of sub lines on the scale.
The setting range is [1] to [9].

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Numerical Color]
Set the color of numeric characters.

• [Value]
Set the number of numeric characters.
The setting range is [2] to [101].

• [Lower Limit] and [Upper Limit]
Set the lower limit and upper limit of the numerical value.
Changes in this setting are automatically applied to the display.

Depending on the item selected for [Data Type] in the [Data] tab, the setting range is 
different.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Font], the numeric character size cannot be set.

Item Description

Without [Sub Scale] With [Sub Scale]

[Upper Limit]

[Lower Limit]

Automatically 
changed.

Change the scale value of Y
Upper limit value: 100 → 500

100

50
0

500

250

100

50

0 50
0

1000
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2) [Vertical Grid] and [Horizontal Grid]
Select this item to display the horizontal or vertical grid.
The number of grids is the same as the number set in [Scale Points] of [Main Scale] and [Sub Scale].
The bottom and left setting in [Axis Position] is prioritized.

After setting this item, select the color of the grid.
3) [Display the graph frame]

Select this item to display the frame of the graph.

4) [Shape]

Item Description

[Shape]

Set the shape of the historical trend graph.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

Horizontal grid

Vertical grid

Graph frame

Preview

[Frame Color]

[Shape Color]
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■3 [Auxiliary Line/Cursor] tab

Set the auxiliary line and attribute of the cursor.

1) [Graph Auxiliary Line]

Item Description

[Reference Line], [Lower Limit Line], and 
[Upper Limit Line]

Set this item to place a reference line on the graph.

• [Display Position]
Select whether to specify the line position using a fixed value or device value.
The following shows the items to be selected.
• [Fixed]:

Specify a constant.
• [Device]:

Specify a device value.
➟6.1.2 How to set devices

• [Line Style]
Select the style of the line.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

• [Width]
Select the width of the line.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

• [Line Color]
Select the color of the line.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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2) [Cursor Attribute]
Set the attribute of the cursor.

Item Description

[Line Style]

Select the style of the line.
The following shows the items to be selected.
• Solid line
• Dotted line
• Broken line
• One-dot chain line
• Two-dot chain line

[Width]

Select the width of the line.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Line Color] Select the color of the line.
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■4 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].

➟8.16.2 ■2 Identifying multiple graphs (setting user IDs)
3) [Single Touch Operation]

Select this item to display a cursor at the touched place.
4) [Display Position Time]

Set this item to display the data obtained at specified time in the center of the graph when the touch switch is 
touched.

5) [Display Setting for Scaling]
Not available to GT21 and GS21.
Configure the settings to enlarge or reduce the time axis of a graph.

Item Description

[Device]

Set the device in which the date data is stored.
The three successive devices following the device set in this item are automatically 
assigned to [yymm], [ddhh], and [mmss].
The date data is stored in the upper eight bits and lower eight bits of each set device.
The data type of the devices is BCD.
➟8.16.2 ■5 Displaying the data obtained at specified time in the center (time specification 

jump function)

Item Description

[Magnification for scaling operation]

Select a magnification factor to enlarge or reduce the time axis of a graph by touching a 
touch switch, pinching in, or pinching out one time.
The following shows the items to be selected.
• [2-fold]
• [4-fold]
• [8-fold]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

7)

2)

3)

4)

5)

6)
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[Display Magnification Notification Device]
Specify a device to store the magnification factor at which the time axis of a graph is being 
displayed.
You can specify a signed 16-bit binary word device or word-specified bit device.

[Shrink the graph to be less than its full scale]

Enables the setting to reduce the time axis of a graph from the original magnification.
When the time axis is reduced, the number of points to be displayed remains unchanged, 
but some pieces of data are thinned out and do not appear on the graph.
Example) When the time axis of a graph is reduced to a magnification of 1/2
The amount of data within the graph display range becomes twice as much as that at the 
original magnification.
Because the number of points to be displayed remains unchanged, every other piece of 
data is thinned out and does not appear on the graph.

[Continue graph update with the latest data at 
the time of scaling] Always updates a graph when the time axis of the graph is enlarged or reduced.

[Graph display magnification for latest data 
display]

Select a magnification factor for the latest data that is displayed with the touch switch, 
screen switching, or graph offset function.
The magnification factors less than 1 are selectable only when [Shrink the graph to be less 
than its full scale] is selected.
The selectable items vary with the selection for [Magnification for scaling operation].
• When [2-fold] is selected for [Magnification for scaling operation]

[8-fold]
[4-fold]
[2-fold]
[full scale]
[1/2]
[1/4]
[1/8]
[1/16]
[1/32]
[1/64]
[1/128]

• When [4-fold] is selected for [Magnification for scaling operation]
[4-fold]
[full scale]
[1/4]
[1/16]
[1/64]
[1/128]

• When [8-fold] is selected for [Magnification for scaling operation]
[8-fold]
[full scale]
[1/8]
[1/64]
[1/128]

Item Description

The time axis of the 
graph is reduced to 
a magnification of 1/2.

Number of points: 7

0

50
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600 120
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100

Number of points: 7

300 60
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Logging data

Graph display range

These pieces of logging data are thinned out 
and do not appear on the graph.
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6) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

7) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [External Output] tab

1) [Time Device]
Stores each date data.
The four successive devices following the device set in this item are automatically assigned to [yymm], [ddhh], 
[mmss], and [Day].
The date data is stored in the upper eight bits and lower eight bits of each set device.
The data type of the devices is BCD.
Using the GOT internal device is recommended for this setting.
For how to display the date data stored in the device in the numerical display, refer to the following.

➟8.16.2 ■4 Storing date data in devices

Item Description

[Cursor Position Time] Set this item to store the time of the cursor display position.
After selecting this item, set the device.

[Beginning Position Time] Set this item to store the time at the beginning position of the graph.
After selecting this item, set the device.

[End Position Time] Set this item to store the time at the end position of the graph.
After selecting this item, set the device.

[Always update Beginning Position Time/End 
Position Time]

Select this item to constantly store the latest value in the Time device (beginning position 
time and end position time).
New data obtained at specified time is stored every graph refresh.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■6 [Trigger] tab

Set conditions for displaying the object.

1) [Control Displaying/Hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■7 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Not available to GT21 and GS21.
Set the expression used for the script function.

➟(2) [Script]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.
The setting of [Data Type] in the [Historical Trend Graph] dialog is applied to the data type of the device set for 
the expression of this item.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Data]

[Lower Limit] (X (lower side)) scale_min[0] ○ ○ When the screen is updated

[Lower Limit] (Y (left side)) scale_min[1] ○ ○ When the screen is updated

[Lower Limit] (Y (upper side)) scale_min[2] ○ ○ When the screen is updated

[Lower Limit] (Y (right side)) scale_min[3] ○ ○ When the screen is updated

[Upper Limit] (X (lower side)) scale_max[0] ○ ○ When the screen is updated

[Upper Limit] (Y (left side)) scale_max[1] ○ ○ When the screen is updated

[Upper Limit] (Y (upper side)) scale_max[2] ○ ○ When the screen is updated

[Upper Limit] (Y (right side)) scale_max[3] ○ ○ When the screen is updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.21.5 Relevant settings

Set the relevant settings other than the specific settings for the historical trend graph as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

[Style]
[Frame Color] frame_color ○ × ×

[Shape Color] plate_color ○ ○ When the screen is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Hiding the upper and lower limit symbols GS450.b10

Retaining the state of the historical trend graph displayed before screen switching and displaying the same 
graph state after switching back to the graph screen
(Historical Trend Graph Display Mode signal: read device)
➟8.21.1 ■4 (9) Holding the graph display state displayed before screen switching

GS450.b9
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8.22 Placing a Graphical Meter

The graphical meter object monitors the value of a word device, and indicates the device value within a range of the 
specified upper and lower limits.

• Semicircle meter

• Horizontal bar meter

8.22.1 Specifications of the graphical meter

■1 Maximum number of objects on one screen
Up to 32 graphical meter objects can be placed on one screen.

■2 Graphical meter shape
The following shows the selectable shapes of the graphical meter.

• Sector
• Semicircle
• Bar (Vertical)
• Bar (Horizontal)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Indication of the monitored device value
The following shows the selectable methods of indicating the device value.

• Needle
The device value is indicated with a needle.
The following needle shapes are selectable: straight line, triangle, and inverted triangle.

• Fill
The device value is indicated by applying a fill (from the lower limit to the device value).
The fill color and design are settable.

• Needle and fill
The device value is indicated by using a needle and applying a fill.

■4 Indication of the device value that is above the upper limit or below the lower limit
If the monitored device value is above the upper limit or below the lower limit, the limit value is indicated as the device 
value on the graphical meter.
Example) Graphical meter having an upper limit of 100 and a lower limit of 0

Needle 
(Straight line)

0 100

50

Needle 
(Triangle)

Needle 
(Inverted triangle)

0 100

50

0 100

50

500 100

Fill

500 100 500 100 500 100

Fill

Needle (Straight line) Needle (Triangle) Needle (Inverted triangle)

D10: 125

The device value is over the upper limit, 
and therefore the needle points to the upper limit.D10: 50

0 100

50

D10: 50

0 100

50

0 100

50

D10: -25

The device value is below the lower limit, 
and therefore the needle points to the lower limit.

0 100

50

D10: 50 → 125

D10: 50 → -25
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■5 Areas of the graphical meter
The graphical meter consists of multiple areas as shown below.
Example) Areas of a sector meter or a horizontal bar meter

• Shape frame area
An area where the frame of the graphical meter shape is displayed.

• Scale area
An area where a scale and scale values are displayed.
The starting and ending edges of the scale area are determined by the angle, data width, and data height of the data 
area.

• Data area
An area where a meter, needle, and fill are displayed.
An upper limit and a lower limit are specified for the meter, and the device value is indicated by the needle and fill.

• Warning color area
An area where warning colors are displayed.
The starting and ending edges of the warning color area are determined by the angle, data width, and data height of 
the data area.

For editing the areas of the graphical meter, refer to the following.
➟8.22.2 ■4 Editing the areas of the graphical meter

Shape frame area

Shape frame area

Scale area

Scale area

Warning color area

Warning color area

Data area

Data area
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8.22.2 How to use the graphical meter

The following shows how to use the graphical meter.

■1 Placing the graphical meter
Step 1 Select [Object] → [Graphical Meter] from the menu to select a graphical meter.
Step 2 Click the position to place a graphical meter.
Step 3 Adjust the size of the graphical meter.
Step 4 Double-click the graphical meter to display the setting dialog.

➟8.22.4 [Graphical Meter] dialog
Step 5 In the [Device/Style] tab, set [Device], [Upper Limit], and [Lower Limit].

➟8.22.4 ■1 [Device/Style] tab
For the other setting items, refer to the following.

➟■3 Setting the graphical meter
Step 6 Click the [OK] button to complete the graphical meter settings.

■2 Editing the graphical meter
The graphical meter is editable on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

(1) Resizing the graphical meter
The size of the graphical meter is changeable.
The resize operation differs depending on the selection for [Shape] in the [Scaling Setting] dialog.

• When [Circle] is selected for [Shape]
The graphical meter is resized while forming a perfect circle.

• When [Square] is selected for [Shape]
The graphical meter is resized with its length-to-width ratio changed.

• When [None] is selected for [Shape]
The graphical meter is resized while its length-to-width ratio remains unchanged.

For the details of the [Scaling Setting] dialog, refer to the following.
➟8.22.4 ■4 [Extended Style] tab

■3 Setting the graphical meter
The setting of the graphical meter can be configured on the screen editor.

➟6.5.5 Common setting for objects

(1) Meter setting
Set the meter shape and design in the [Device/Style] tab of the [Graphical Meter] dialog.

➟8.22.4 ■1 [Device/Style] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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50

0 100
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8 - 612 8. OBJECT FUNCTION
8.22 Placing a Graphical Meter



8

O
B

JE
C

T 
FU

N
C

TI
O

N

(2) Text setting
Set the text to be displayed on the graphical meter in the [Text] tab of the [Graphical Meter] dialog.

➟8.22.4 ■2 [Text] tab

(3) Scale setting
Set the scale and scale values of the graphical meter in the [Scale] tab of the [Graphical Meter] dialog.

➟8.22.4 ■3 [Scale] tab

(4) Shape setting
Set the shape of the graphical meter in the [Extended Style] tab of the [Graphical Meter] dialog.
Only the shapes in the library are selectable.

➟8.22.4 ■4 [Extended Style] tab

(5) Needle and fill settings
Set how to indicate a device value on the graphical meter in the [Extended Style] tab of the [Graphical Meter] dialog.

➟8.22.4 ■4 [Extended Style] tab

(6) Warning color setting
Set warning colors to be displayed on the graphical meter in the [Extended Style] tab of the [Graphical Meter] dialog.

➟8.22.4 ■4 [Extended Style] tab

500 100

50

0 100

25 75

Sector meter Text

Horizontal bar meterHorizontal bar meter

Scale
500 100

50

0 100

25 75

500 100

50

0 100

25 75
Shape

50

0 100

25 75
500 100

Needle

Fill

500 100

50

0 100

25 75

Warning color
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■4 Editing the areas of the graphical meter
The areas of the graphical meter are editable on the screen editor.
Click the graphical meter to display the handles and operating auxiliary lines for the warning color area, scale area, and 
data area. The handles for the warning area and scale area are rectangle-shaped, and the handle for the data area is 
rhombus-shaped.
Drag a handle or operating auxiliary line to edit an area.
Example) Handles and operating auxiliary lines displayed for the areas of a sector meter

(1) Editable area
The following shows the editable areas.

(a) Warning color area and scale area
The warning color area or scale area is movable.
When you move the area in a sector or semicircle meter, the area is resized with its width unchanged.

• Sector meter

• Vertical bar meter

(b) Data area
The angle or the data width and height are changeable.
When you change the above items, the warning color area and scale area are resized accordingly.

• Sector meter
The angle of the data area is changeable.

• Vertical bar meter

Handle for the scale area

Handle for the warning color area
Operating auxiliary line 
for the scale area

Operating auxiliary line 
for the warning color area

Handle for the data area

Area width

Moving the 
warning 
color area

: Shape frame
: Data area
: Warning color area

: Shape frame
: Data area
: Warning color area

Moving the warning 
color area

: Shape frame
: Data area
: Warning color area

Changing the 
end angle
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The data width and height of the data area are changeable.

(2) Scope of editing the areas
The scope of editing the areas differs depending on the selection for [Shape] in the [Scaling Setting] dialog.
For the details of the [Scaling Setting] dialog, refer to the following.

➟8.22.4 ■4 [Extended Style] tab

(a) When [Circle] is selected for [Shape]
The areas of the graphical meter are editable beyond the shape frame.
If you resize an area beyond the shape frame, the frame is resized to accommodate the area automatically.

• Sector meter

(b) When [Square] is selected for [Shape]
The areas of the graphical meter are editable beyond the shape frame.
If you resize an area beyond the shape frame, the frame is resized to accommodate the area automatically.

• Sector meter

• Vertical bar meter

Data width

Changing the 
data height

Data height

: Shape frame
: Data area
: Warning color area

Editing the data area

Editing the warning color area

Changing the 
end angle

Moving the 
warning 
color area

: Shape frame
: Data area
: Warning color area

Editing the data area

Editing the warning color area

: Shape frame
: Data area
: Warning color area

Changing the 
end angle

Moving the 
warning 
color area
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(c) When [None] is selected for [Shape]
The areas of the graphical meter are editable only within the shape frame.

• Sector meter

• Vertical bar meter

Editing the data area

Editing the warning color area

Changing the 
data height

Moving the warning 
color area

: Shape frame
: Data area
: Warning color area

Editing the data area

Editing the warning color area

: Shape frame
: Data area
: Warning color area

Changing the 
end angle

Moving the 
warning 
color area

Editing the data area

Editing the warning color area

: Shape frame
: Data area
: Warning color area

Changing the 
data height

Moving the 
warning 
color area
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8.22.3 Precautions for a graphical meter

■1 Behavior of the graphical meter when it is resized
(1) Scale area and warning color area

Even if the graphical meter is resized, the widths of the scale area and warning color area remain unchanged.
To change the widths of the areas, set the relevant items in the [Graphical Meter] dialog.

➟8.22.4 [Graphical Meter] dialog
Example) When the graphical meter is enlarged

(2) Shape frame width and axis radius
The set value of [Frame Width] or [Axis Radius] in the [Scaling Setting] dialog determines whether the shape frame width 
or axis radius remains unchanged while the graphical meter is resized.

• When [Frame Width] or [Axis Radius] is set to a value other than [0]
The shape frame width or axis radius remains unchanged while the graphical meter is resized.
Example) When the graphical meter is enlarged

• When [Frame Width] or [Axis Radius] is set to [0]
The shape frame width or axis radius is changed while the graphical meter is resized.
Example) When the graphical meter is enlarged

For the details of the [Scaling Setting] dialog, refer to the following.
➟8.22.4 ■4 [Extended Style] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Width of the warning 
color area

Width of the shape 
frame area

The widths of the areas 
remain unchanged.

Enlarged

Enlarged

The shape frame width and 
axis radius remain unchanged 
while the graphical meter is resized.

Axis radius

Shape frame width

The shape frame width and 
axis radius are changed while 
the graphical meter is resized.

Enlarged
Axis radius

Shape frame width
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■2 Shape setting
The shape of the graphical meter may not appear properly if you make different selections in the following settings: 
[Shape] in the [Graphical Meter] dialog ([Extended Style] tab), and [Shape] in the [Scaling Setting] dialog.
Check the display of the shape, and change the selection for [Shape] in the [Scaling Setting] dialog if necessary.
For the details of the [Scaling Setting] dialog, refer to the following.

➟8.22.4 ■4 [Extended Style] tab
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8.22.4 [Graphical Meter] dialog

Step 1 Select [Object] → [Graphical Meter] from the menu to select a graphical meter.
Step 2 Click the position to place a graphical meter.
Step 3 Double-click the graphical meter to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Text] tab
■3 [Scale] tab
■4 [Extended Style] tab
■5 [Extended] tab
■6 [Trigger] tab
■7 [Operation/Script] tab

■1 [Device/Style] tab

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of the word device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)

When [Bar (Vertical)] or [Bar (Horizontal)] is selected 
for [Meter Shape]6)

5)
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3) [Monitoring Range]

4) [Style]

Item Description

[Upper Limit], [Lower Limit]

Select whether to set the data area (upper and lower limits) of the graphical meter with fixed values or 
device values.
The following shows the items to be selected.
• [Fixed]: 

Set a constant.
The setting range depends on the selection for [Data Type].

• [Device]: 
Set a device.

➟6.1.2 How to set devices

[Boundary Value 1], [Boundary 
Value 2]

Set these items to divide the data area of the graphical meter.
Select whether to divide the data area with fixed values or by ratio.
The data area is divided into the middle, upper, and lower ranges based on the settings of [Boundary 
Value 1] and [Boundary Value 2].

The following shows the items to be selected.
• [Fixed]: 

These items are settable only when [Fixed] is selected for [Upper Limit] and [Lower Limit].
Set a constant.
The setting ranges for [Boundary Value 1] and [Boundary Value 2] are different.
For [Boundary Value 1], the setting range is the set value of [Lower Limit] to the set value of [Upper 
Limit].
For [Boundary Value 2], the setting range is the set value of [Lower Limit] to the set value of [Boundary 
Value 1].

• [Ratio]: 
Set a radio for dividing the data area based on [Upper Limit] (100%) and [Lower Limit] (0%).
The setting ranges for [Boundary Value 1] and [Boundary Value 2] are different.
For [Boundary Value 1], the setting range is [1]% to [99]%.
For [Boundary Value 2], the setting range is [1]% to the set value of [Boundary Value 1].

Item Description

[Meter Shape]

Select a meter shape.
The following shows the items to be selected.
• [Sector]
• [Semicircle]
• [Bar (Vertical)]
• [Bar (Horizontal)]

[Preset Selection]

Select a graphical meter design.
Click the pull-down menu button to display all designs.

[Direction]

Select the value increment direction for the graphical meter.
The selectable items vary with the selection for [Meter Shape].
• When [Sector] or [Semicircle] is selected for [Meter Shape]

[Clockwise]
[Counterclockwise]

• When [Bar (Vertical)] is selected for [Meter Shape]
[Up]
[Down]

• When [Bar (Horizontal)] is selected for [Meter Shape]
[Right]
[Left]

Upper 
limit

Lower 
limit

Boundary 
value 1

Boundary 
value 1

Boundary 
value 2

Upper 
limit

Lower 
limit

Upper rangeUpper rangeUpper rangeUpper range

Middle rangeMiddle range

Middle rangeMiddle range

Lower rangeLower range

Upper 
limit

Lower 
limit

Middle rangeMiddle range

Pull-down menu button
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5) [Preview Value]
Set a value or ratio for the graphical meter to be previewed on GT Designer3.
The setting range varies with the selection for [Upper Limit] and [Lower Limit].

• When [Fixed] is selected for [Upper Limit] and [Lower Limit]
The setting range is the set value of [Lower Limit] to the set value of [Upper Limit].

• When [Device] is selected for [Upper Limit] and [Lower Limit]
Set a ratio based on [Upper Limit] (100%) and [Lower Limit] (0%).
The setting range is [0]% to [100]%.

6) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

[Beginning Angle (Base Point)], 
[End Angle]

These items are settable when [Sector] or [Semicircle] is selected for [Meter Shape].
Set an angle to define the meter shape.
The setting range is [-360.0] degrees to [360.0] degrees.
The angle is settable in units of 0.1 degree.
Regardless of the selection for [Direction], the 0-degree position is always at the 3 o'clock position, and 
the angle increases counterclockwise.

[Data Width], [Data Height]

These items are settable when [Bar (Vertical)] or [Bar (Horizontal)] is selected for [Meter Shape].
Set the width and height of the meter.
When [Bar (Vertical)] is selected for [Meter Shape], the value of [Data Width] is applied to [Needle 
Length] in the [Extended Style] tab.
When [Bar (Horizontal)] is selected for [Meter Shape], the value of [Data Height] is applied to [Needle 
Length] in the [Extended Style] tab.
When [Circle] or [Square] is selected for [Shape] in the [Scaling Setting] dialog, the object is resized 
according to the specified width and height of the meter.

Item Description

90° or -270°
Increase 

(Positive direction)

Decrease 
(Negative direction)

0°

270° or -90°

180° or -180°
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■2 [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

Setting items differ depending on the selected text type.
For the setting items for each text type, refer to the following.

➟(1) [Text]
(2) [Comment]

Item Description

[Text]

Directly input the text to be displayed.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Set the comment in the comment group as the text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Text]

1) [Common Setting of Display Position]

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

[Italic] button
[Underline] button
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2) [Text Settings]

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4.2 Color settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Display Position]

Set the position of the text to be displayed on the object.
The text is displayed at each position (Center, Up, Down, Left, Right).
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

[Solid] button
[Raised] button

[Bold] button

Up
Shape frame

Down

Left Right
0 10050

CenterCenter

Text

Distance between the object frame and the text

0 10050
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(2) [Comment]

1) [Comment Group]

Item Description

[Fixed] Select this item to use the specified comment group.
After selecting this item, directly enter the comment group No. to be used.

[Device]

Select this item to display the comment group No. corresponding to the value of the device 
to be set.
After selecting this item, set the device.
➟6.1.2 How to set devices

[Adjust Text Size] The text size is automatically adjusted so that it fits the object size.
When this item is not selected, the line feed is automatically applied to the text.

[Minimum Size] Set the minimum text size for when [Adjust Text Size] is enabled.
The setting range is [8] to [240] dot(s).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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2) [Comment]

3) [Text Settings]

Item Description

[Comment No.]

Set the comment No. of the comment to be used.
• [Fixed]:

Select this item to use the specified comment.
After selecting this item, directly enter the comment No. to be used.
To edit the displayed comment, click the [Edit] button and edit the comment in the [Edit 
Comment] dialog.
If an unregistered comment group No. or comment No. is set, create a new comment.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the 
upper right of the comment input field.

• Number of characters:
A one-byte or two-byte character is counted as one character.
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one 
row.

• [Device]:
Select this item to display the comment No. corresponding to the value of the device to 
be set.
After selecting this item, set the device.

Item Description

[Font]

Select the font of the displayed text.
The following shows the items to be selected.
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font

This item is selectable when [Group No.] is set to [Fixed].
Displays text in the font specified with [Windows Font] in the [Comment Group Property] 
dialog.

• [Windows Font Setting] button
Displays the [Comment Group Property] dialog to list the properties of the comment 
group specified with [Group No.].
Set [Windows Font] and [Character Set] for the target column of the comment group.
➟5.8.4 ■2 (1) [Comment Group Property] dialog

[Text Size]
For the settable text sizes by font, refer to the following.
➟1.2.5 Font specifications
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4) [Preview]

[Change Attribute of Comment Setting]

Select this item to change the comment attribute.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4.2 Color settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

[Alignment] Set the vertical or horizontal position of the text.

[Offset to Frame]

Set the offset between the frame of the object and the text in units of dots.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines in units of dots.
The setting range is [0] to [128] dot(s).

Item Description

[Group No.]
Set the group No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Group No.] of [Comment Group], the value set in [Comment 
Group] is fixed.

[Column No.] Set the column No. of the comment to be displayed on the screen of GT Designer3.

[Comment No.]
Set the comment No. of the comment to be displayed on the screen of GT Designer3.
When [Fixed] is selected for [Comment No.] of [Comment], the value set in [Comment] is 
fixed.

Item Description

[Solid] button
[Raised] button

[Bold] button

0 10050
Text

Offset to FrameDistance between the object frame and the text
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■3 [Scale] tab

1) [Scale Display]
Displays a scale on the graphical meter.

2) Scale design
Select a scale design.

3) [Layout]

Item Description

[Scale Direction]

This item is settable when [Sector] or [Semicircle] is selected for [Meter Shape] in the [Device/Style] tab.
Select the orientation of scale marks.
This setting does not change the position and size of the scale area.
The following shows the items to be selected.
• [Outward]
• [Inward]

[Scale Position]

This item is settable when [Bar (Vertical)] or [Bar (Horizontal)] is selected for [Meter Shape] in the 
[Device/Style] tab.
Select the orientation of scale marks.
The selectable items vary with the selection for [Meter Shape] in the [Device/Style] tab.
• When [Bar (Vertical)] is selected for [Meter Shape]

[Left Side]
[Right Side]
If the selection is changed, the graphical meter is flipped horizontally.

• When [Bar (Horizontal)] is selected for [Meter Shape]
[Upside]
[Downside]
If the selection is changed, the graphical meter is flipped vertically.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

When [Bar (Vertical)] or [Bar (Horizontal)] is selected 
for [Meter Shape] in the [Device/Style] tab

2)

4)

1)

5)

[Outward]

Scale area

[Inward]

[Left Side] [Right Side]

[Upside] [Downside]
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4) [Main Scale]
Displays main scale marks.

[Scale Alignment]

Select the position to align scale marks.
The following shows the items to be selected.
• [Inside]
• [Outside]
• [Center]

[Scale Reference Line]

Set the reference line for the scale.
When [Scale Display] is not selected, no reference line is displayed.
The selectable items vary with the selection for [Scale Alignment].
• When [Inside] or [Outside] is selected for [Scale Alignment]

[None]
[Underline]
[Underline + Center Line]

• When [Center] is selected for [Scale Alignment]
[None]
[Center Line]

Item Description

[Scale Color]
Select the color of main scale marks.
➟6.4.2 Color settings

[Scale Points] Specify the number of main scale marks.
The setting range is [2] to [101].

[Scale Width]

Select the width of main scale marks.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Scale Length]
Set the length of main scale marks.
When [Circle] or [Square] is selected for [Shape] in the [Scaling Setting] dialog, the object is resized 
according to the specified length of the scale marks.

[Sub Scale]

Displays subscale marks.

The width and length of subscale marks default to half of the set values of [Scale Width] and [Scale 
Length].

[Scale Color]
Select the color of subscale marks.
➟6.4.2 Color settings

[Scale Points] Specify the number of subscale marks.
The setting range is [1] to [9].

Item Description

[Inside]

Scale value 0 10050 0 10050 0 10050

[Outside] [Center]

[None] [Underline] [Underline + Center Line]

[Center Line]

Main scale mark Subscale mark

Subscale mark
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5) [Scale Value]
Displays scale values.

Item Description

[Numerical Color]
Select the color of scale values.
➟6.4.2 Color settings

[Numerical Value] Specify the number of scale values.
The setting range is [2] to [101].

[Scale Font]

Select the font for scale values.
The following shows the items to be selected.
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows Font

[Numerical Size]
Set the size of scale values in the specified font.
For the settable sizes by font, refer to the following.
➟1.2.5 Font specifications

[Number of Decimals] Set the number of decimal places of a scale value.
The setting range is [0] to [6].

[Move monitoring range and 
scale value range together]

This item is settable when [Fixed] is selected for [Upper Limit] and [Lower Limit] in the [Device/Style] tab.
The upper and lower limits of the scale value range are identical to the values of [Upper Limit] and [Lower 
Limit] set in the [Device/Style] tab.
When you change the set values of [Upper Limit] and [Lower Limit] in the [Device/Style] tab, the upper 
and lower limits of the scale value range are changed accordingly.

[Upper Limit], [Lower Limit]
Set the upper and lower limits of the scale value range.
These items are not settable when [Move monitoring range and scale value range together] is selected.
The setting range depends on the selection for [Data Type] in the [Device/Style] tab.

Scale value 0 10050
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■4 [Extended Style] tab

1) [Shape]
Select the shape of the graphical meter.
Only the shapes in the library are selectable.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
2) [Shape Color]

Select the shape color.
The following shows the items to be selected.

• [Blue]
• [Red]
• [Yellow]
• [Green]
• [Orange]
• [Cyan]
• [Purple]
• [Pink]
• [Gray]
• [Gold]
• [Silver]
• [Black]
• [White]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

2)

4)

1)

6)

7)

When [Triangle] or [Inverted Triangle] is 
selected for [Shape]

8)

3)
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3) [Scaling Setting] button
Displays the [Scaling Setting] dialog to set the details of the selected shape.

4) [Meter Attribute]
Select the method of indicating the device value.
The selectable items vary with the selection for [Meter Shape] in the [Device/Style] tab.

• When [Sector] or [Semicircle] is selected for [Meter Shape]
[Needle]

• When [Bar (Vertical)] or [Bar (Horizontal)] is selected for [Meter Shape]
[Needle]
[Fill]
[Needle and Fill]

5) [Needle Attribute]
This item is settable when [Needle] or [Needle and Fill] is selected for [Meter Attribute].
Set a needle to indicate the device value.

• [Shape]
Select the shape outline.
The selectable items vary with the selection for [Meter Shape].
· When [Sector] or [Semicircle] is selected for [Meter Shape]
[Circle]
[Square]
[None]
· When [Bar (Vertical)] or [Bar (Horizontal)] is selected for [Meter 
Shape]
[Square]
[None]

• [Frame Width]
This item is settable when [Circle] or [Square] is selected for 
[Shape].
Set the frame width of the selected shape.
The settable minimum value is [0], and the settable maximum value 
varies with the shape size.
When [0] is set, the frame width is changed while the graphical 
meter is resized.

• [Axis Radius]
This item is settable when [Circle] is selected for [Shape].
Set the axis radius.
The settable minimum value is [0], and the settable maximum value 
varies with the size of the shape or object.
When [0] is set, the axis radius is changed while the graphical meter 
is resized.

• [Central Coordinate (X)], [Central Coordinate (Y)]
These items are settable when [None] is selected for [Shape].
Specify the X and Y coordinates of the meter center by ratio.
The upper left corner of the shape is set as 0%.
The setting range is [0.0]% to [100.0]%.

Item Description

[Shape]

Select a needle shape.
The following shows the items to be selected.
• [Straight Line]
• [Triangle]
• [Inverted Triangle]

[Needle Color]
Select a needle color.
➟6.4.2 Color settings

When [Circle] is selected for [Shape]

When [Square] is selected for [Shape]

When [None] is selected for [Shape]

[Needle] [Fill] [Needle and Fill]
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6) [Fill Attribute]
This item is settable when [Needle] or [Needle and Fill] is selected for [Meter Attribute].
Set a fill to indicate the range of the lower limit to the device value.

[Needle Width]

This item is settable when [Straight Line] is selected for [Shape].
Select the width of the needle.
The following shows the items to be selected.
• [1 Dot]
• [2 Dot]
• [3 Dot]
• [4 Dot]
• [5 Dot]
• [7 Dot]

[Base Width]
This item is settable when [Triangle] or [Inverted Triangle] is selected for [Shape].
Set the base length of the triangle with an odd number.
The setting range is [3] (dots) to the set value of [Needle Length] (dots).

[Needle Length]

Set the length of the needle.
When [Bar (Vertical)] is selected for [Meter Shape], the value of this item is applied to [Data Width] in the 
[Device/Style] tab.
When [Bar (Horizontal)] is selected for [Meter Shape], the value of this item is applied to [Data Height] in 
the [Device/Style] tab.
When [Circle] or [Square] is selected for [Shape] in the [Scaling Setting] dialog, the object is resized 
according to the specified length of the needle.

[Hollow Radius]

This item is settable when [Sector] or [Semicircle] is selected for [Meter Shape] in the [Device/Style] tab.
Set the distance from the meter center to the drawing start position of the needle.
The setting range is [0] (dots) to "[Needle Length] - 2" (dots).
The needle is drawn from the center of the data area.

Item Description

[Design]

Select the fill design.
The following shows the items to be selected.
• [Gradation 1]
• [Gradation 2]
• [Gradation 3]
• [Gradation 4]
• [3D (Convex)]
• [3D (Concave)]
• [Plain Color (Bright)]
• [Plain Color (Dark)]
• [Plain Color (Light)]

[Background Color]

Select the color of the portion that is not filled in the data area.
The following shows the items to be selected.
• [Blue]
• [Red]
• [Yellow]
• [Green]
• [Orange]
• [Cyan]
• [Purple]
• [Pink]
• [Gray]
• [Gold](Supported soon)
• [Silver]
• [Black]
• [White]

Item Description

When [Hollow Radius] is set to [0] dots When [Hollow Radius] is set to [10] dots

Fill No fill 
(Background color)
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7) [Warning Color Setting]
Set the warning color by range.
Selecting this item displays the warning color area.
The warning color area is divided based on the upper, middle, and lower ranges of the data area.
To reposition the warning color area, select and move the area on the screen editor.

For the boundary value settings, refer to the following.
➟■1 [Device/Style] tab

[Upper Range Color], [Middle 
Range Color], [Lower Range 
Color]

Select fill colors for the upper range, middle range, and lower range.
Each range appears in its specified color.
[Upper Range Color] is settable when [Boundary Value 1] is set in the [Device/Style] tab.
[Lower Range Color] is settable when [Boundary Value 1] and [Boundary Value 2] are set in the [Device/
Style] tab.
For the boundary value settings, refer to the following.
➟■1 [Device/Style] tab
The following shows the items to be selected.
• [Blue]
• [Red]
• [Yellow]
• [Green]
• [Orange]
• [Cyan]
• [Purple]
• [Pink]
• [Gray]
• [Gold](Supported soon)
• [Silver]
• [Black]
• [White]

Item Description

Lower 
range

Middle 
range

Upper 
range

Fill

Device value

Background color

Lower 
range

Middle 
range

Upper 
range

Fill

Device value

Background 
color

Fill

Device value

Background 
color

Lower 
range

Middle 
range

Upper 
range

Selected colors

Lower range: 
Middle range: 
Upper range: 

Lower 
range

Middle 
range

Upper 
range

Warning color area

Lower 
range

Middle 
range

Upper 
range

Warning color areaMiddle 
range

Lower 
range

Warning color area

Upper 
range
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8) [Part Names ]
Displays the image of the graphical meter to which the settings configured in this tab are applied.

Item Description

[Design]

Select a warning color area design.
The following shows the items to be selected.
• [Gradation 1]
• [Gradation 2]
• [Gradation 3]
• [Gradation 4]
• [3D (Convex)]
• [3D (Concave)]
• [Plain Color (Bright)]
• [Plain Color (Dark)]
• [Plain Color (Light)]

[Upper Range Color], [Middle 
Range Color], [Lower Range 
Color]

Select colors for the upper range, middle range, and lower range of the warning color area.
[Upper Range Color] is settable when [Boundary Value 1] is set in the [Device/Style] tab.
[Lower Range Color] is settable when [Boundary Value 1] and [Boundary Value 2] are set in the [Device/
Style] tab.
The following shows the items to be selected.
• [Blue]
• [Red]
• [Yellow]
• [Green]
• [Orange]
• [Cyan]
• [Purple]
• [Pink]
• [Gray]
• [Gold](Supported soon)
• [Silver]
• [Black]
• [White]

[Range Width]
Set the width of the warning color area.
When [Circle] or [Square] is selected for [Shape] in the [Scaling Setting] dialog, the object is resized 
according to the specified width of the warning color area.
8. OBJECT FUNCTION
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■5 [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [KANJI Region]

Set the KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

4) [Layer]
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

5) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)
4) 5)

2)
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■6 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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■7 [Operation/Script] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.
➟(1) [Data Operation]

• [Script]
Set the expression used for the script function.
➟(2) [Script]

(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the selection for [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the selection for [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.22.5 Relevant settings

Set the relevant settings other than the specific settings for the graphical meter as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Extended 
Style] [Needle Color] graph_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.23 Placing a Level Object

This function monitors the word device value and fills the specified area with the user-selected color, based on the ratio 
of the device value compared to the set upper and lower limit values.
With this function, the device value can be displayed as a level in any closed figure.

A value or comment is displayable on a level object by placing one of the following objects on the level object.
• Numerical display
• Numerical input
• Comment display

If any object mentioned above is placed under the level object on the same layer, this object still appears in front of the 
level object on the GOT screen.
The display mode of the value or comment varies depending on the relevant settings.

When any object mentioned above is superimposed on a level object, the transparent mode is applied.
The transparent mode displays the text in the overlapping portion of the objects in the specified color.

When any object mentioned above is superimposed on a level object, the XOR mode or the transparent mode is 
selectable.
The XOR mode inverts the text color in the overlapping portion of the objects.
The transparent mode displays the text in the overlapping portion of the objects in the specified color.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.23.1 Specifications of the level object

The following shows the specifications of the level object.

■1 Maximum number of objects arrangeable on one screen
Up to 1024 objects can be arranged on one screen.
Maximum number of level objects is calculated by subtracting the number of objects other than level objects from 1024.

■2 Objects that can be superimposed on a level object
The following shows the objects that can be superimposed on a level object.

• Numerical display
• Numerical input
• Comment display (bit comment, word comment)

Multiple objects can be superimposed on one level object.
Regardless of the order in which the objects are placed on GT Designer3, the overlapping object (numerical display, 
numerical input, or comment display) appears in front of the level object on the GOT screen.

D100 = 25

25
D100 = 50

Numerical display

Level 
object

50

XOR mode Transparent mode
D100 = 25

25
D100 = 50

Numerical display

Level 
object

50

Example of superimposing a numerical display on a level object

Example of superimposing a comment display on a level object
Comment display

Level 
object

XOR mode

Comment display

Level 
object

Transparent mode
D100 = 25 D100 = 50

Decrease AppropriateAppropriate

D100 = 25

Decrease

D100 = 50

AppropriateAppropriate
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8.23.2 How to use the level object (GOT Graphic Ver.2)

■1 Placing a parts display to add a frame to a level object
The level object has no frame setting.
To add a frame to a level object, place a parts display on the level object.

Before setting a level object, create a part to be used as the frame of the level object, and specify the part for a parts 
display.
The following shows the procedure for using a parts display (fixed parts) as an example.

Step 1 Create a part to be used as the frame.
Leave a space in the place where a level object is to be displayed.

For creating a part, refer to the following.
➟5.9.3 ■1 Registering parts

Step 2 Place a parts display (fixed parts).

➟8.8.6 [Fixed Parts Display] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.2

Level object
(rear)

Parts display
(front)

Overlapped

Space

Rectangle (figure)

Polygon (figure)

Rectangle (figure)

Polygon (figure)
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■2 Placing a level object
The following shows how to place a level object.

Step 1 Select [Object] → [Meter] → [Level] from the menu.
Step 2 Click the position to place a level object on a screen editor.
Step 3 To use a parts display to add a frame to the level object, adjust the position and size of the level object to fit 

in the space left in the part that is specified as the frame.
Step 4 Move the adjusted level object under the parts display.

Right-click the level object, and select [Stacking Order] → [Move to the Back] from the displayed menu.

■3 Setting the level object
The following shows how to set the level object.

Step 1 Double-click the level object which has been placed to display the setting dialog.

➟8.23.5 [Level] dialog
Step 2 Display the [Device/Style] tab.

➟8.23.5 ■1 [Device/Style] tab
Step 3 Set a device to be monitored for [Device].

➟6.1.2 How to set devices
Step 4 Set [Direction], [Lower Limit], and [Upper Limit].

Step 5 Set the fill color with [Level Color], [Background Color], and [Pattern].

Step 6 To change the fill color according to the device value, add conditions.
After adding conditions, set the following.

• Ranges corresponding to each condition
• [Level Color], [Background Color], and [Pattern] that are displayed when the conditions are satisfied

Step 7 Click the [OK] button to complete the level object settings.

Space

Level
object

Parts
display

Adjust the position and size
of the level object.

3. Move the level object under
the parts display.

4.

500

0 0

50

100
Display direction (up)

Lower limit value, upper limit value 
(lower limit value: 0, upper limit value: 500)

500

0 0

50

100

Area to be filled

Target of the level display
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■4 Displaying a value or text on a level object
To display a value or text on a level object, place one of the following objects within the frame of the level object.

• Numerical display
• numerical input
• Comment display (bit comment, word comment)

Regardless of the order in which the objects are placed on GT Designer3, the overlapping object (numerical display, 
numerical input, or comment display) appears in front of the level object on the GOT screen.

Step 1 Place one of the above objects within the frame of a level object.
Step 2 Configure the settings of the relevant object, including the device and the display method.

For the settings of each object, refer to the following.
➟8.4.4 [Numerical Display] dialog
8.4.5 [Numerical Input] dialog
8.7.4 [Bit Comment Display] dialog
8.7.5 [Word Comment Display] dialog

Step 3 Click the [OK] button to complete the object settings.

The following shows an example of settings.
Example) Displaying the level with the comment display
Set the same condition (display range) for the level and comment display, and switch the level color and comment 
simultaneously.

Condition No. Display range Level color Comment Font image

1 71<=$V Red Increase

2 $V<=30 Yellow Decrease

0
(normal) - Light blue Appropriate

90 Numerical display
Appro-
priate Comment display

IncreaseIncrease+ =

DisplayLevel setting Comment setting

Level
Device to be monitored    : D100
Display direction               : Up
Upper limit value              : 100
Lower limit value              : 0

Comment
Device to be monitored  : D100
Registered comments    : Comment No. 1...Increase
                                       : Comment No. 2...Decrease
                                       : Comment No. 3...Appropriate

Increase

Decrease

Appropriate
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8.23.3 How to use the level object (GOT Graphic Ver.1)

The following shows how to use the level object.

■1 Drawing a figure in which a level is displayed
To display a level in a figure, draw the figure in advance.
When drawing a figure, note the following.

➟7. FIGURES

(1) Drawing a figure in the back layer
GT21 and GS21 are single-layered.
There is no need to consider layers on which figures and level objects are placed.
To display a level in a figure, draw the figure and level object in the back layer.
If the level object is drawn in the front layer, the figure is not the target of the level display.

(2) Setting the same color for [Line Color] of a figure and [Boundary Color] of a level
The figure drawn in the same color as [Boundary Color] of the level is the target of the level display.
After placing the level object, set the same color as [Line Color] of the figure for [Boundary Color].

(3) Drawing a figure without any clearance between lines
A level can be displayed only with a completely-closed figure.
A figure drawn with multiple lines can also be used for the level display.
Draw a figure in which a level is displayed without any clearance between lines.

■2 Placing the level object
The following shows how to place the level object.

Step 1 Select [Object] → [Meter] → [Level] from the menu.
Step 2 Click the position to place a level object on a screen editor.
Step 3 Adjust the frame size of the level object.

To display a level in a figure, surround the figure with the frame of the level object and adjust the frame 
according to the figure size.
When the color of the figure is reversed, the figure is set as the target of the level display.

When the color of the figure is not reversed, the internal coordinate mark of the level object is not 

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.1

The figure drawn in a color 
other than the boundary 
color is filled.

Frame of the level object

You can display the level on a figure 
drawn only with lines when there is 
no clearance between the lines.

Frame of the level object

Internal 
coordinate 

mark

Level

Figure
8 - 646 8. OBJECT FUNCTION
8.23 Placing a Level Object



8

O
B

JE
C

T 
FU

N
C

TI
O

N

superimposed with the figure.
Move the internal coordinate mark manually.
Right-click the frame of the level object and select [Touch Area Edit] → [Manual Edit] from the menu to drag 
the internal coordinate mark.

■3 Setting the level object
The following shows how to set the level object.

Step 1 Double-click the level object which has been placed to display the setting dialog.

➟8.23.5 [Level] dialog
Step 2 Display the [Device/Style] tab.

➟8.23.5 ■1 [Device/Style] tab
Step 3 Set a device to be monitored for [Device].

➟6.1.2 How to set devices
Step 4 Set [Direction], [Boundary Color], [Lower Limit], and [Upper Limit].

Set the same color as [Line Color] (frame line color) of the target figure of the level display for [Boundary 
Color].

Step 5 Set the fill color for [Level Color], [Background Color], and [Pattern].

Step 6 To change the fill color according to the device value, add conditions.
After adding conditions, set the following.

• Ranges corresponding to each condition
• [Level Color], [Background Color], and [Pattern] that are displayed when the conditions are satisfied

Step 7 Click the [OK] button to complete the level object settings.

Figure in which 
a level is displayed

Frame of the range 
in which a level is 
displayed

The figure is not set as 
the target of the level display.

The figure is set as 
the target of the level display.

500

0 0

50

100
Display direction (up)

Boundary color 
(Set the same color as that of the frame line of the figure.)
Lower limit value, upper limit value 
(lower limit value: 0, upper limit value: 500)

500

0 0

50

100

Area to be filled

Target of the level display
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■4 Displaying a value or text on a level object
To display a value or text on a level object, place one of the following objects within the frame of the level object.

• Numerical display
• Numerical input
• Comment display (bit comment, word comment)

Regardless of the placing order, the objects superimposed with level objects (numerical display, numerical input, and 
comment display) are displayed over the level objects on the GOT.

Step 1 Place an object within the frame of the level object.
Step 2 Display the setting dialog of the object.

For the setting dialog, refer to the following.
➟8.4.4 [Numerical Display] dialog
8.4.5 [Numerical Input] dialog
8.7.4 [Bit Comment Display] dialog
8.7.5 [Word Comment Display] dialog

Step 3 Select the display color, which is used when the level area to be filled and the object are overlapped, in 
[Display Mode].

• [Transparent]: The color of a numerical value or characters is not changed.
• [XOR]: The color of a numerical value or characters and the level color are integrated into an XOR 

synthesis.

Step 4 Click the [OK] button to complete the object settings.
Step 5 When [Blink] or [Reverse] is set for the object, select [Common] → [GOT Type Setting] from the menu, and 

set [Adjust object display order in GOT to the one in GT Designer3].
With this setting, the blinking display and reversing display of the object to be superimposed with the level 
are enabled.

The following shows an example of settings.
Example) Displaying the level with the comment display
Set the same condition (display range) for the level and comment display, and switch the level color and comment 
simultaneously.

90 Numerical display
Appro-
priate Comment display

50
[Transparent]

50
[XOR]

50
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Condition No. Display range Level color Comment Font image

1 71<=$V Red Increase

2 $V<=30 Yellow Decrease

0
(normal) - Light blue Appropriate

IncreaseIncrease+ =

DisplayLevel setting Comment setting

Level
Device to be monitored    : D100
Display direction               : Up
Upper limit value              : 100
Lower limit value              : 0

Comment
Device to be monitored  : D100
Display mode                  : Transparent
Registered comments    : Comment No. 1...Increase
                                       : Comment No. 2...Decrease
                                       : Comment No. 3...Appropriate

Increase

Decrease

Appropriate
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8.23.4 Precautions for a level object

This section explains the precautions for the level object.

■1 Precautions for superimposing an object on a level object
(1) Precautions for the display
(a) When a level object and a figure overlap one another

Even if a level object and a figure overlap one another on the same layer, the figure is filled with the level color on the 
GOT screen.
To use a figure as the frame of a level object, register the figure as a part, specify the part for a parts display, and position 
the parts display on the level object.

➟8.23.2 ■1 Placing a parts display to add a frame to a level object

(b) When a part of the object is out of the frame of the level object

When a part of the object (numerical display, numerical input, or comment display) is out of the frame of the level object, 
the level or the object is displayed incorrectly.

• When a part of the object placed behind the level object is out of the frame of the level object
The area of the object within the frame of the level object is not displayed.
Only the area out of the frame of the level object is displayed.

• When a part of the object placed over the level object is out of the frame of the level object
The level is not displayed only for the area superimposed with the object.
To solve the above problems, execute one of the following operations.

• Move the whole object outside the frame of the level object.
• Move the whole object within the frame of the level object.
• Set [Adjust object display order in GOT to the one in GT Designer3] (Not available to GT21.)

Select [Adjust object display order in GOT to the one in GT Designer3]. (Not available to GT21 and GS21)

(c) When a level object and an object are placed in different layers

GT21 and GS21 are single-layered.
There is no need to consider layers on which level objects and other objects are placed.
When a level object and an object (numerical display, numerical input, or comment display) are placed in different layers, 
the level and the object are not integrated into an XOR synthesis.

• When a level object is placed in the front layer and an object is placed in the back layer
If the level area to be filled is superimposed with the object, the object is hidden.

• When an object is placed in the front layer and a level object is placed in the back layer
The object is displayed over the level. However, the object and level are not integrated into an XOR synthesis 
because they are in different layers.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2

GOT Graphic Ver.1

GOT Graphic Ver.1

Numerical display

Level

Numerical display

Level

50
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(2) Precautions for the operation
(a) Update timing of the displayed contents

The displayed comments of an object (numerical display, numerical input, or comment display) and a level are updated 
simultaneously.
The update timing set for the object (display condition) is invalid.
To set the update timing of the object different from that of the level, set [Adjust object display order in GOT to the one in 
GT Designer3].
This setting is available in the [GOT Type Setting] dialog displayed by selecting [Common] → [GOT Type Setting] from 
the menu.

(b) Blink, reverse

Normally, an object (numerical display, numerical input, or comment display) which is superimposed with a level object 
does not blink or reverse.
To blink or reverse the object superimposed on the level object, select [Adjust object display order in GOT to the one in 
GT Designer3]. (Not available to GT21 and GS21)

(c) Display at inputting a numerical value

While a cursor is displayed at the numerical input, the area superimposed with the level object is displayed incorrectly.
After the numerical input is completed and the level is updated, the area is displayed correctly.

(d) Text style of the comment display

When the text style (bold, solid, raised) is set for the comment display, the text or the text color may be displayed 
incorrectly.

■2 Precautions for the lower and upper limit values
(1) Operations of when the monitored device value exceeds the upper or lower limit value

When the monitored device value exceeds the lower limit value, the display of the lower limit value is applied.
When the monitored device value exceeds the upper limit value, the display of the upper limit value is applied.

(2) Operations of when the lengths of the frame of a level object and a figure are different
When the lengths of the frame of a level object and a figure are different in the direction of the level display, the figure is 
not filled corresponding to the ratio compared to the upper and lower limit values.
Adjust the frame length of the level object to the length of the figure.

GOT Graphic Ver.1

GOT Graphic Ver.1

GOT Graphic Ver.1

GOT Graphic Ver.1

Lower limit value: 0
D10: -100 D10: 600

Upper limit value: 500

The lengths are the same.

Display
direction

Upper limit 
value: 100

D10: 80

Lower limit 
value: 0

Up to 80% of the area is filled.

The lengths are different.
Upper limit 
value: 100

D10: 80

Lower limit 
value: 0

Frame of the level object

Display
direction

The whole area of the figure is filled.
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8.23.5 [Level] dialog

The level object is an object that monitors the word device value and fills the specified area with the user-selected color, 
based on the ratio of the device value compared to the set upper and lower limit values.

Step 1 Select [Object] → [Meter] → [Level] from the menu.
Step 2 Click the position where you place the level object. Placing the level object is complete.
Step 3 Double-click the level object which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Extended] tab
■3 [Trigger] tab
■4 [Operation/Script] tab

■1 [Device/Style] tab

Set the target device to be monitored and the level status corresponding to the device value.
For the conditions, refer to the following.

➟6.5.5 ■2 Setting conditions

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of the word device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1) 2)

9)

10)

11)

7)

8)

12)

4) 5) 6)
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• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

3) [Number of States]
The number of the set conditions

4) Add button
Adds a new condition.

5) Delete button
Deletes the selected condition.

6) Up button, down button
Changes the order of priority of the selected condition.

7) Preview list
Displays set conditions.

8) [Utilize] button
Creates a new condition utilizing the selected condition.

9) [Display Format (Common)]
Set the level display that is common to all conditions.

Item Description

[Direction]

Select the direction in which the level area to be filled extends.
The following shows the items to be selected.
• [Up]
• [Down]
• [Left]
• [Right]

[Boundary Color]

Set the same color as [Line Color] (frame line color) of the target figure of the level display.
Set this item to display a level in a figure.

If a color other than [Line Color] of the figure is set, the level is not displayed in the frame of the figure.

[Lower Limit], [Upper Limit]

Select whether to specify the display range (lower and upper limit values) of the level with the fixed value 
or with the device value.
The following shows the items to be selected.
• [Fixed]:

Specify a constant.
• [Device]:

Specify a device value.
➟6.1.2 How to set devices
The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].

GOT Graphic Ver.1

Frame line of the figure

Figure Figure

Frame of 
the level object

Frame of 
the level object

Example1) 
When [Boundary Color] of the figure 
and [Line Color] are the same

Example2) 
When [Boundary Color] of the figure 
and [Line Color] are different

 The figure is set as 
the target of the level display.

The figure is not set as 
the target of the level display.
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10) [Range]

11) [Color Setting]

12) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.

Item Description

[Range]

Set the display range of the conditions selected in the preview list.
When setting the value of the word device as the condition, click the [Range] button to display the [Edit 
Range] dialog, and then set the conditional expression.
➟6.5.5 ■2 Setting conditions

Item Description

[Level Color] Set the fill color.

[Pattern], [Background Color]

Set the pattern and the background color to be used for filling.

[Pattern] + [Level Color]

[Background Color][Background Color]
[Pattern]

Example) [Level Color] :
:
:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3) 4)
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The following shows the items to be selected.
• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

4) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■3 [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

■4 [Operation/Script] tab

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Not available to GT21 and GS21.
Set the expression used for the script function.

➟(2) [Script]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the selection for [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]

Select a shifting direction.
The following shows the items to be selected.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the selection for [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

[Device/Style]

[Level Color] graph_color ○ ○ When the object is updated

[Mask Pattern] pattern ○ ○ When the object is updated

[Background Color] back_color ○ ○ When the object is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.23.6 Relevant settings

Set the relevant settings other than the specific settings for the level object as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.24 Placing a Panelmeter

This function monitors the word device value and indicates the relative value to the set upper and lower limit values with a 
needle.

Application examples
Panelmeter for displaying the A/D conversion value of current of 12 mA

8.24.1 Specifications of the panelmeter

The following shows the specifications of the panelmeter.

■1 Maximum number of objects arrangeable on one screen
Up to 1024 objects can be arranged on one screen.
Maximum number of panelmeters is calculated by subtracting the number of objects other than panelmeters from 1024.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

20

10

0
Ammeter

10

200
Ammeter

10

200
Ammeter

D100 = 2000D100 = 1000 D100 = 3000

0 4000

0 20

10

Ammeter

Conversion value
Monitors the value of D10.

Scale value
Displays the current input range.

Lower limit, upper limit
Set the digital output range.

Current input range    : 0 to 500 liter
Digital output range      : D10
Conversion value       : 0 to 100%

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.24.2 How to use the panelmeter

The following shows how to use the panelmeter.
Step 1 Select [Object] → [Meter] → [Panelmeter] from the menu.
Step 2 Click the position where you place the panelmeter, and the panelmeter is placed.
Step 3 Adjust the frame size of the panelmeter.
Step 4 Double-click the panelmeter to display the setting dialog.

➟8.24.4 [Panelmeter] dialog
Step 5 Display the [Device/Style] tab.

➟8.24.4 ■1 [Device/Style] tab
Step 6 Set a device to be monitored for [Device].

➟6.1.2 How to set devices
Step 7 Set [Type], [Beginning Angle], [End Angle], [Needle Shape], [Needle Color], [Distance from the Axis], [Shape 

Settings], [Lower Limit], and [Upper Limit].

Step 8 Set the fill color for [Fill Color], [Background Color], and [Pattern].
Step 9 Set [Scale Settings]and [Text] in the [Scale/Text] tab.

➟8.24.4 ■2 [Scale/Text] tab

Step 10 To change the color of the panelmeter according to the device value, add conditions in the [Range] tab.

➟8.24.4 ■3 [Range Setting] tab
After adding conditions, set the following.

• Ranges corresponding to each condition
• [Fill Color], [Background Color], and [Pattern] that are displayed when the conditions are satisfied

Step 11 Set [Needle Color], [Fill Color], [Background Color], and [Pattern] that are displayed when the added 
conditions are satisfied.

Step 12 Click the [OK] button to complete the panelmeter settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

0 4000

Shape frame

Monitored device value

Display direction 
(clockwise)

Needle shape and color

Meter type ([Custom])

Distance from the meter 
center to the drawing 
start position of the needle

Lower limit value: 0, upper limit value: 4000)

0 4000

-100 100

0
Line (number of lines: 5)

Scale value (lower limit value: -100, 
upper limit value: 100)

Text (direct input)

Ammeter
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8.24.3 Precautions for a panelmeter

The following shows the precautions for the panelmeter.

■1 When the monitored device value exceeds the upper or lower limit value
When the monitored device value exceeds the lower limit value, the display of the lower limit value is applied.
When the monitored device value exceeds the upper limit value, the display of the upper limit value is applied.

8.24.4 [Panelmeter] dialog

The panelmeter is an object that monitors the word device value and indicates the relative value to the set upper and 
lower limit values with a needle.

Step 1 Select [Object] → [Meter] → [Panelmeter] from the menu.
Step 2 Click the position where you place the panelmeter, and the panelmeter is placed.
Step 3 Double-click the panelmeter to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Scale/Text] tab
■3 [Range Setting] tab
■4 [Extended] tab
■5 [Trigger] tab
■6 [Operation/Script] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D10: -50 D10: 4200

Lower limit value: 0 Upper limit value: 4000

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Device/Style] tab

Set the target device to be monitored and the panelmeter status corresponding to the device value.

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of the word device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

3) [Lower Limit], [Upper Limit]
Select whether to specify the display range (lower and upper limit values) of the panelmeter with the fixed value or 
with the device value.
The following shows the items to be selected.

• [Fixed]:
Specify a constant.

• [Device]:
Specify a device value.
➟6.1.2 How to set devices

The setting range of [Lower Limit] and [Upper Limit] differs depending on the item selected for [Data type].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1) 2)

4)

5)

6)
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4) [Meter Format]

Item Description

[Type]

Select the shape of the panelmeter.
The following shows the items to be selected.
• [Top 1/6]
• [Bottom 1/6]
• [Left 1/6]
• [Right 1/6]
• [Top-Right 1/4]
• [Top-Left 1/4]
• [Bottom-Left 1/4]
• [Bottom-Right 1/4]
• [Top 1/2]
• [Bottom 1/2]
• [Left 1/2]
• [Right 1/2]
• [3/4]
• [Full Circle]
• [Custom]

If you select [Full Circle], set the base point.

• [Base Point]
Select the base point (the point where the upper or lower limit is displayed).
The following shows the items to be selected.
• [0]
• [90]
• [180]
• [270]

While selecting any other than [Custom] for [Type], inputting an angle to [Beginning Angle] or [End Angle] 
sets [Type] to [Custom].

[Direction]

Select the direction in which the value of the meter increases.
The following shows the items to be selected.
• [Clockwise]
• [Counterclockwise]

[Beginning Angle] and [End 
Angle]

Set the shape of the panelmeter by specifying angles.
The setting range is [-360.0] degrees to [360.0] degrees.
The angle is settable in units of 0.1 degree.
When any other than [Custom] is selected for [Type], the set values of [Beginning Angle] and [End Angle] are 
changed to defaults according to the selected item.
Regardless of [Base Point] and [Direction] for [Full Circle], the 0-degree position is always at the 3 o'clock 
position, and the angle increases counterclockwise.

[Top 1/6] [Bottom 1/6] [Left 1/6] [Right 1/6] [Top-Left 1/4] [Top-Right 1/4] [3/4]

[Full Circle][Right 1/2][Left 1/2][Bottom 1/2][Top 1/2]
[Bottom-Right 

1/4]
[Bottom-Left 

1/4]

0°

90°

180°

270°

90° or -270°
Increase 

(Positive direction)

Decrease 
(Negative direction)

0°

270° or -90°

180° or -180°
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[Meter Attribute]

Select a display method for the panelmeter.
The following shows the items to be selected.
• [Needle]
• [Fill]
• [Needle and Fill]

When selecting [Needle] or [Needle and Fill], set the needle shape.

• [Needle Shape]
Select a needle shape.
The following shows the items to be selected.
• [Straight Line]
• [Triangle]
• [Inverted Triangle]

When selecting [Triangle] or [Inverted Triangle] for [Needle Shape], set the base width of the triangle.

• [Base Width]
Set the base width of the triangle.
The setting range is [3] (dots) to "the meter radius" (dots).
Specify an odd number value.

When selecting [Needle] or [Needle and Fill], set the needle color.

• [Needle Color]
Select a needle color.

When selecting [Needle] or [Needle and Fill], set the distance from the meter center to the drawing start 
position of the needle.

• [Distance from the Axis]
Set the distance from the meter center to the drawing start position of the needle.
The setting range is [0] (dot) to "the meter radius -2" (dots).

Item Description

[Needle] [Fill] [Needle and Fill]

[Straight Line] [Triangle] [Inverted Triangle]

When [Base Width] 
is set to [3] dots

When [Base Width] 
is set to [15] dots

When [Distance from the Axis] 
is set to [0] dot

When [Distance from the Axis] 
is set to [15] dots
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[Meter Attribute]

When either of [Fill] or [Needle and Fill] is selected, set the fill color.

• [Fill Color]
Select the fill color.

• [Pattern], [Background Color]
Select the pattern and the background color to be used for filling.

[Meter Frame]

Set this item to frame the panelmeter.

The line width of the frame is 1 dot and the display color is white.

[Meter Panel]

Set this item to paint the panel of the panelmeter.

When [Meter Frame] is set, this setting is available.

• [Fill Color]
Select the color of the panel.

• [Pattern], [Background Color]
Select the pattern and the background color to be used for the panel.

[Core]

Set this item to paint the core of the panelmeter.
Set the radius of the target area.

The setting range is [1] to [139] dot(s). ,

• [Fill Color]
Select the fill color of the core.

• [Pattern], [Background Color]
Select the pattern and the background color to be used for the core.

Item Description

[Pattern] + [Fill Color]

[Background Color]

Example)

[Background Color]
[Pattern]
[Fill Color] :

:
:

Mater frame

Mater panel

Radius
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5) [Shape]

6) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Scale/Text] tab

Item Description

[Shape]

Set the shape of the panelmeter.
When [None] is selected, no shape is displayed.
To select a shape other than those in the list box, click the [Shape] button.
➟6.5.5 ■1 Setting object shapes
When selecting a shape in [Basic Figure], set the color of the frame and of the shape.

• [Frame Color]
Set the color of the frame.

• [Shape Color]
Set the color of the shape.

• Preview
Displays a preview of the set shape.

Preview

Needle

[Shape Color]

[Frame Color]

Panel

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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1) [Scale Settings]
Displays lines and values on the scale on the panelmeter.

Item Description

[Scale]

Set this item to display lines on the scale.

• [Scale Points]
Set the number of lines on the scale.
The setting range is [2] to [101].

• [Color]
Set the color of lines on the scale.

[Scale Value]

Set this item to display numeric characters as the scale value.

• [Value]
Set the number of numeric characters.
The setting range is [2] to [101].

• [Color]
Set the color of numeric characters.

• [Scale Value] ([Lower Limit], [Upper Limit])
Set the lower and upper limit values of numeric characters.
Changes in this setting are automatically applied to the display.

The setting range differ depending on the item selected for [Data type] in the [Device/
Style] tab.
The setting range of 64-bit devices is the same as that of 32-bit devices.

• [Scale Font]
Select the font of numeric characters.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

• [Number Size]
Select the size of numeric characters.
For the details of the font and size, refer to the following.

➟1.2.5 Font specifications
When [6x8dot] is selected for [Scale Font], this item cannot be set.

0

-100 100

0

-100 100
Displays both the lines 

and scale values.
Line

(Number of lines: 5)
Scale value
(Value: 3)

-100 0

0

100 100

50

Change [Lower Limit].

Automatically changed.

Example)
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2) [Common Settings of Display Position]
Set this option to display text on the panelmeter.

Item Description

[Text Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [TrueType Mincho]
• [TrueType Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)
• Windows font
When a Windows font is selected, italicizing and underlining text are available.

• [Italic] button
Italicizes the text.

• [Underline] button
Underlines the text.

[Character Set] When a Windows font is selected, select a character set.

[Text Size]

Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications
When [6x8dot] is selected for [Text Font], this item cannot be set.

[Text Color]

Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.

➟6.4 Color Settings
• [Bold] button

Displays the text in bold.
• [Solid] button

Displays the text with a shadow.
• [Raised] button

Displays the text embossed.
• [Solid Color]

When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

[Italic] button
[Underline] button

[Solid] button
[Raised] button

[Bold] button
8. OBJECT FUNCTION
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3) [Text Setting]
Select this item to monitor multiple devices by switching between them.

Item Description

[Display Position]

Set the position of the text.
After clicking [Display Position], input the texts to be displayed in each position.
• [Center] button: Displays the text at the center of the object.
• [Up] button: Displays the text on the upper side of the object.
• [Down] button: Displays the text on the lower side of the object.
• [Left] button: Displays the text on the left side of the object.
• [Right] button: Displays the text on the right side of the object.

[Text]

Input the text to be displayed.
Up to 1024 characters can be set.
To display the text in multiple lines, press the [Enter] key at the end of the text in each line.
(When a line feed is inserted, two characters per line feed are added to the number of 
characters.)

[Alignment]

Set the horizontal and vertical positions of the text.

• [Horizontal]
Set the horizontal position of the text.
• Left button:

Aligns the text to the left.
• Center button:

Aligns the text to the center.
• Right button:

Aligns the text to the right.
• [Vertical]

Set the vertical position of the text.
• Top button:

Aligns the text to the top.
• Center button:

Aligns the text to the center.
• Bottom button:

Aligns the text to the bottom.

[Offset to Frame]

Set the offset between the text and the frame of the object.
The setting range is [0] to [100] dot(s).

[Line Space] Set the space between lines.
The setting range is [0] to [128] dot(s).

Up

Down

CenterLeft Right

Center button
Bottom button

Top button

Left button
Center button

Right button

Text

Text

Text Text
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■3 [Range Setting] tab

For the conditions, refer to the following.
➟6.5.5 ■2 Setting conditions

1) [Number of States]
The number of the set conditions

2) Add button
Adds a new condition.

3) Delete button
Deletes the selected condition.

4) Up button, down button
Changes the order of priority of the selected condition.

5) Preview list
Displays set conditions.

6) [Utilize] button
Creates a new condition utilizing the selected condition.

7) [Range]

8) [Needle/Fill Attribute]

Item Description

[Range]

Set the display range of the conditions selected in the preview list.
When setting the value of the word device as the condition, click the [Range] button to display the [Edit 
Range] dialog, and then set the conditional expression.
➟6.5.5 ■2 Setting conditions

Item Description

[Needle Color]
Set the color of the needle.
When either of [Needle] or [Needle and Fill] is selected for [Meter Attribute] in the [Device/Style] tab, set 
the color of the needle.

[Fill Color]
Set the fill color.
When either of [Fill] or [Needle and Fill] is selected for [Meter Attribute] in the [Device/Style] tab, set the fill 
color.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

1)

8)

6)

2) 3) 4)

7)
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■4 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Select this item to monitor multiple devices by switching between them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [KANJI Region]

Set the KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

[Pattern], [Background Color]

Set the pattern and the background color to be used for filling.

Item Description

[Pattern] + [Fill Color]

[Background Color]

Example)

[Background Color]
[Pattern]
[Fill Color] :

:
:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4) 5)

2)

[Japan] [China(GB)-Mincho]

Example) Difference between [Japanese] 
                 and [China(GB)-Mincho]
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4) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

5) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■5 [Trigger] tab

Set conditions for displaying the object.

1) [Control Displaying/Hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

2) [Trigger Type]
Select the condition of displaying the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [Range]
• [Bit Trigger]
• [ON Sampling]
• [OFF Sampling]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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The selectable items vary with the GOT model.
For details, refer to the following.

➟6.2.1 ■2 Correspondence between functions and trigger types
3) [Settings]

For details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

■6 [Operation/Script] tab

Set a formula for monitoring with the data operation function or the script function.

1) [Operation Type]
To use the data operation or script, select the operation type.
The following shows the items to be selected.

• [None]
Select this item if the data operation and script are unnecessary.

• [Data Operation]
Set the expression used for the data operation.

➟(1) [Data Operation]
• [Script]

Set the expression used for the script function.
➟(2) [Script]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Data Operation]

For the settings of the data operation function, refer to the following.
➟6.5.5 ■4 Setting data operations

1) [Bit Mask]
Set the operation of mask processing.

2) [Bit Shift]
Set the operation of shift processing.

3) [Data Operation]
Set the format of the expression.
The following shows the items to be selected.

• [None]:
Select this item not to perform the data operation by using the expression.

• [Data Expression]:
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to set the format of the expression in the [Edit Data Expression] dialog.

Item Description

[Mask Type]

Select a type of mask processing.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)
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(2) [Script]

For the settings of scripts, refer to the following.
➟9.10 Object Script

(a) Correspondence between the object settings and the object properties used in scripts
You can read (reference) the set value from an object setting or write (change) a new value to the setting by using an 
object property in a script.
The following shows the correspondence between the relevant setting items in the object setting dialog and the object 
properties used in scripts.
○: Available
×: Not available
-: No setting item available in the setting dialog for the applicable object properties

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

- -

active ○ ○ Upon the setting change

x ○ ○ When the screen is updated

y ○ ○ When the screen is updated

width ○ × ×

height ○ × ×

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*1 For the timing at which the setting change of an object property is reflected, refer to the following.

➟9.10.2 ■2 (5) Timing at which the setting change of an object property is reflected
*2 To enable the object stacking order adjustment, select [Adjust object display order in GOT to the one in GT Designer3] in 

the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

8.24.5 Relevant settings

Set the relevant settings other than the specific settings for the panelmeter as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

[Device/Style]

[Needle Color] graph_color ○ ○ When the object is updated

[Meter Panel] back_color ○ ○ When the object is updated

[Frame Color] frame_color ○ × ×

[Plate Color] plate_color ○ ○ When the object is updated

[Mater Panel Pattern] pattern ○ ○ When the object is updated

[Mater Panel Background Color] pattern_bg_color ○ ○ When the object is updated

[Fill Color] fill_color ○ ○ When the object is updated

[Fill Background Color] fill_bg_color ○ ○ When the object is updated

[Fill Pattern] fill_pattern ○ ○ When the object is updated

[Core] core_color ○ ○ When the object is updated

[Core Background Color] core_bg_color ○ ○ When the object is updated

[Core Pattern] core_pattern ○ ○ When the object is updated

[Lower Limit] scale_min[0] ○ ○ When the screen is updated

[Upper Limit] scale_max[0] ○ ○ When the screen is updated

[Extended] [Security Level] security ○ ○ When the object is 
updated

When the screen is 
updated

Setting dialog Object property

Tab name Setting item Property name Read Write

Timing for reflecting the setting change*1

GOT Graphic Ver.1 
(Object stacking order 
adjustment enabled*2)

GOT Graphic Ver.2

GOT Graphic Ver.1 
(Object stacking order 
adjustment disabled*2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.25 Placing a Slider

Use the slider to set the continuous value to the device within any setting range.
The value of the destination where you stop the knob is input to the device.

8.25.1 Specifications of the slider

The following shows the specifications of the slider.

■1 Maximum number of objects arrangeable on one screen
Up to 1024 sliders can be set on a screen.

■2 Minimum size of slider
Arrange the slider on the screen not smaller than the following size.

• When [Horizontal] is selected for [Slider Direction]: 18 dots (width) × 16 dots (height)
• When [Vertical] is selected for [Slider Direction]: 16 dots (width) × 18 dots (height)

8.25.2 How to use the slider

The following shows how to use the slider.

■1 Arranging the slider
Arrange the slider on the screen editor.

➟6.5.1 Placing figures and objects

Arrangement positions of the slider and the other input object
Arranging an input object, such as a touch switch, near the slider arrangement area may cause a malfunction 
when you touch the input object during slider operation.
It is recommended not to arrange any input object in or near the slider arrangement area.

■2 Editing the slider
Edit the slider arranged on the screen editor.

➟6.5.3 Editing figures and objects

■3 Setting the slider
Configure the settings for the slider arranged on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Settings of sliders
➟8.25.3 [Slider] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Production line
Current 
output
Set output

20
20 ％

％

0 50 100

Production line
Current 
output
Set output

20
70 %

%

Changing the set output with the slider

0 50 100

Production line
Current 
output
Set output

20
20 ％

％

0 50 100

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Slider operation
This section describes the operations of the slider.
Touch the area where the slider is arranged. Select the setting value, and release the finger so that the setting value is 
written into the device.

➟8.25.3 ■3 [Extended] tab

(1) When touch-and-holding the knob to slide
Touch-and-hold the knob to slide until the destination.
When the finger is released from the slider arrangement area, the knob is displayed at the destination, and the setting 
value is changed simultaneously.

(2) When touching the slider arrangement area
When you touch the value to be set, the knob moves to the touched position.
When the finger is released from the slider arrangement area, the knob is displayed at the destination, and the setting 
value is changed simultaneously.

0 50 100

0 50 100

Slider 
arrangement 
area

Releasing the finger 
from the slider 
arrangement area

Knob

Touching the 
slider knob

Touch-and-holding 
the knob to slide

0 50 100

0 50 100

Releasing the finger 
from the slider 
arrangement area

Slider 
arrangement 
area

Knob Bar

Touching the 
target position 
on the bar
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8.25.3 [Slider] dialog

Step 1 Select [Object] → [Slider] from the menu.
Step 2 Click the position where you arrange the slider to complete the arrangement.
Step 3 Double-click the arranged slider to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Scale] tab
■3 [Extended] tab
■4 [Trigger] tab
■5 [Operation] tab

■1 [Device/Style] tab

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of the device.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4)
6)
7)

8)

12)

9)

5)

2)

10)

11)
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3) [Lower Limit] and [Upper Limit]
Select whether to specify the display range (lower and upper limit values) of the slider with the fixed value or with 
the device value.
The following shows the items to be selected.

• [Fixed]:
Specify a constant.

• [Device]:
Specify a device value.
➟6.1.2 How to set devices

The setting ranges of [Lower Limit] and [Upper Limit] differ depending on the item selected for [Data Type].
4) [Slider Direction]

Select the slider direction from [Horizontal] or [Vertical].
The following shows the items to be selected.

• [Horizontal]: Arranges the slider to be displayed in horizontal direction.
• [Vertical]: Arranges the slider to be displayed in vertical direction.

5) [Moving Direction]
Select the moving direction of the knob.
The setting range differs depending on the item selected for [Slider Direction].
When [Horizontal] is selected for [Slider Direction]

• [Right]: Slides the knob from the left (lower limit) to the right (upper limit).
• [Left]: Slides the knob from the right (lower limit) to the left (upper limit).

When [Vertical] is selected for [Slider Direction]
• [Up]: Slides the knob from the bottom (lower limit) to the top (upper limit).
• [Down]: Slides the knob from the top (lower limit) to the down (upper limit).

6) [Knob Width] and [Knob Height]
Specify the width and height of the knob.
The setting range depends on the type of the screen on which a slider is placed.

Item [Slider Direction]
Setting range (dot)

Base screen Window screen or library editor

[Knob Width]
[Horizontal] [16] to [2998] [16] to [1998]

[Vertical] [16] to [3000] [16] to [2000]

[Knob Height]
[Horizontal] [16] to [3000] [16] to [1600]

[Vertical] [16] to [2998] [16] to [1598]

Display example of when [Horizontal] is 
selected for [Slider Direction], and 
[Right] is selected for [Moving Direction]

0 50 100

Knob

Knob 0

50

100

Bar

Display example of when [Vertical] is 
selected for [Slider Direction], and 
[Up] is selected for [Moving Direction]
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After the width and height of the knob are specified, when the setting of [Slider Direction] is changed, the set values 
of [Knob Width] and [Knob Height] are switched.

7) [Bar Width] and [Bar Height]
Specify the width and height of the bar.
The setting range depends on the type of the screen on which a slider is placed.

When [Horizontal] is selected for [Slider Direction], the set value of [Bar Width] varies according to the object size 
adjusted directly on the screen editor. When [Vertical] is selected for [Slider Direction], the set value of [Bar Height] 
varies according to the object size adjusted directly on the screen editor.

➟6.5.3 ■3 Changing sizes
After the width and height of the bar are specified, when the setting of [Slider Direction] is changed, the set values 
of [Bar Width] and [Bar Height] are switched.

8) Preview list
The display status of the knob and the bar

9) [Collectively set ON/OFF shape in the case of Basic Figure]
This item is available when [Basic Figure] is selected for [Shape].

10) [Shape]
Select the shapes of the knob and the bar.
From the list box, only one item can be selected either for the knob or for the bar.
To select a shape other than those in the list box, click the [Shape] button.

➟6.5.5 ■1 Setting object shapes
11) [Shape Attribute]

Item [Slider Direction]
Setting range (dot)

Base screen Window screen or library editor

[Bar Width]
[Horizontal] [18] to [3000] [16] to [2000]

[Vertical] [4] to [3000] [4] to [2000]

[Bar Height]
[Horizontal] [4] to [3000] [4] to [1600]

[Vertical] [18] to [3000] [18] to [1600]

Item Description

[Frame Color] Select the frame colors of the knob and the bar.

[Shape Color] Select the shape colors of the knob and the bar.

[Pattern] and [Background 
Color]

Select the patterns and background colors of the knob and the bar.
The selected pattern in the shape color is displayed on the background color.

Relationship between the width and 
the height when [Horizontal] is 
selected for [Slider Direction]

0 50 100

Knob

Knob
0

50

100

Bar

Bar

Relationship between the width 
and the height when [Vertical] is 
selected for [Slider Direction]

Width

Width

Height

Height

Pattern + Shape color

Background color

Example )

Background color:
Pattern:
Shape color:
8 - 682 8. OBJECT FUNCTION
8.25 Placing a Slider



8

O
B

JE
C

T 
FU

N
C

TI
O

N

12) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Scale] tab

1) [Scale]
Arrange the slider scale.

2) [Scale Value]
Arrange the scale values.

Item Description

[Scale Points] Specify the number of scale points.
The setting range is [2] to [101].

[Color]
Set the scale color.
➟6.4 Color Settings

[Adjust the knob stop position to the scale]

Adjusts the knob stop position to the scale by matching the centers of the knob and the 
scale points.
When the following setting is configured, the knob does not stop at the scale points 
correctly.
• The data type is not a real number.
• (Upper limit of monitor device - Lower limit of monitor device + 1) < Number of scale points

Item Description

[Value] Specify the number of scale values.
The setting range is [2] to [101].

[Color]
Set the color of scale values.
➟6.4 Color Settings

[Lower Limit] and [Upper Limit]

Specify the lower limit and upper limit of scale values.
The setting range differs depending on the item selected for [Data Type] in the [Device/
Style] tab.
The setting range of 64-bit devices is the same as that of 32-bit devices.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■3 [Extended] tab

1) [Security Level]
When using the security function, set the security level.
The setting range is [1] to [15].
When not using the security function, set the level to [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Use offset]

Monitors multiple devices by switching them.
After selecting this item, set the offset device.

➟6.1.11 Offset
3) [User ID]

Enables the user ID setting.
The setting range is [1] to [65535].
Setting the user ID enables you to identify the object with the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
4) [Operation Log Target]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Targets the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
5) [Update the device during knob operation]

Updates the device in the fixed cycle (500 ms) during knob operation.
6) [Layer]

Not available to GT21 and GS21.

[Scale Font]

Select the scale font.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)

[Number Size]
Select the size of the scale value.
For the details of the font and the size, refer to the following.
➟1.2.5 Font specifications

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)
4)
5)

6)
7)
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Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]
➟6.5.5 ■3 Superimposition

7) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category

■4 [Trigger] tab

1) [Control displaying/hiding]
Set the device that controls display/hide of the object.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

2) [Trigger Type]
Select a trigger condition to display the object.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

For the details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

Refresh timing for slider operations and device values
When the display conditions or the operating conditions of the object are unsatisfied, the slider stops operating.
The value is also not written to the device.
Therefore, the value written to the device may differ from the value of the knob stop position during slider 
operation.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
8. OBJECT FUNCTION
8.25 Placing a Slider

8 - 685



■5 [Operation] tab

1) [Operation Type]

2) [Bit Mask]
Sets the operation of mask processing.

3) [Bit Shift]
Sets the operation of shift processing.

4) [Data Operation]
Set the format of the expression.

Item Description

[None] Does not use the data operation function.

[Data Operation] Sets the expression used for the data operation function.

Item Description

[Mask Type] Select a type of mask processing.
• [AND]: Logical AND

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Shifts to the left
• [Right]: Shifts to the right

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[None] Dose not perform the data operation by using the expression.

[Data Expression] Performs the data operation by using the expression.

[Exp] button

This button is available only when [Data Expression] is selected for [Data Operation].
Click the [Exp] button to set the format of the expression in the [Edit Data Expression] 
dialog.
➟6.5.5 ■4 (3) [Edit Data Expression] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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3)
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8.25.4 Relevant settings

Set the relevant settings other than the specific settings for the slider as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT 
Designer3

Always enabled.

[Adjust object display order in GOT to the one in GT Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.26 Placing a Document Display

This function displays documents created with a personal computer (such as Microsoft Word and Microsoft Excel) on the 
GOT.
With this function, the GOT can display specifications and manuals. Thus, you can utilize the documents for the screen 
of troubleshooting, or display the documents for the operation during monitoring.

8.26.1 Specifications of the document display

The following shows the specifications of the document display.

■1 Usable document type
The following shows the types of documents displayable on a document display object.

(1) PDF file
The PDF file under the following conditions is displayed without conversion to JPEG format.

• Any TTF font is embedded in the file.
• No password is required to open the file.

(2) Document Converter output file
JPEG file that is converted from a document in another file format with Document Converter.
The following shows the documents that can be converted to JPEG format with Document Converter.

• Microsoft Word file
• Microsoft Excel file
• Microsoft PowerPoint file
• PDF file
• Image file (JPEG, BMP)

■2 Usable drive
The following shows the drives usable to store the files to be displayed on the document display object.

• Drive A
• Drive B
• Drive E
• Drive F
• Drive G
• Drive N
• Drive X (current drive)

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

■3 Document ID
ID number that is set for a document to appear on the document display.
The setting range is 1 to 32767.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Display the document for the operation of 
objects such as touch switches on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Displaying a cached document
PDF files are cached to speed up the display of the files on the document display.
A PDF file is cached or a cached PDF file is updated when the file is displayed.
The cached PDF file is stored in the CACHE folder on the drive where the source PDF file is stored.

■5 Maximum number of objects on one screen
One document display can be placed on one screen.

■6 Number of objects that can be displayed at one time
One document display can be displayed for each document type at one time.
If the same document type is set for multiple document displays, these document displays cannot be displayed 
simultaneously.
Regardless of using the overlap window, superimpose window, or set overlay screen, the multiple document displays are 
unavailable.

■7 Displaying the [Search] or [Bookmark] window for a PDF file
One system window is used for the [Bookmark] or [Search] window operation.
For system windows, refer to the following.

➟5.2.1 ■2 (5) Using an overlap window as the system window

8.26.2 How to use the document display (for PDF files)

The following shows how to display PDF files on the document display.

■1 Procedure for displaying PDF files
The following shows the procedure for displaying PDF files.

For the details of the operations below, refer to the following.
• Storing PDF files on a data storage or file server

➟■2 Storing files on a data storage or file server
• Setting a document display object with GT Designer3

➟■3 Placing the document display
8.26.6 [Document Display] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PDF file

Document ID: 3
Document ID: 2

Document ID: 1

PDF

GOT2000 (Document display)

Storing PDF files

Connecting a data storage 
or file server to the GOT

Writing the project data that contains the document display setting to the GOT

GT Designer3 (Object setting)

Data storage or file server
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■2 Storing files on a data storage or file server
In the root directory of a drive, create a folder named "PDFDAT", and store PDF files in the folder.
Create folders and files in the PDFDAT folder as shown below.

• Document ID setting
According to the hierarchical structure of the folders and files, set a document ID number in each folder name or file 
name.
A five-digit document ID number is settable.
The setting range is 00001 to 32767.

• Hierarchical structure of the folders and files
To store PFD files, use one of the following hierarchical structures.
If multiple hierarchical structures are used, an unintended PDF file may appear on the document display.

➟(1) Storing PDF files by document ID number
(2) Storing a PDF file to each folder named with a document ID number

(1) Storing PDF files by document ID number
Store the PDF file whose file name includes a document ID number.
To store multiple PDF files, set a different document ID number for each file name.

• Hierarchical structure of the folders and files

• PDF file name
Set a PDF file name that includes a document ID number, an underscore, and user-specified characters as shown 
below.

(2) Storing a PDF file to each folder named with a document ID number
Create folders named with a different document ID number, and store one PDF file to each folder.
Name the PDF file freely.

(Data storage or network drive)

project

PDFDAT

00001_instruction.pdf

00010_operation.pdf

Document ID: 1
User-configured settings

Document ID: 100

Document ID: 10

00100_tutorial-01.pdf

Any character string set by a user

Document ID
Underline

00100 _ tutorial-01.pdf

(Data storage or network drive)

project

PDFDAT

instruction.pdf

00001

00010

00100

operation.pdf

Document ID: 1

User-configured settings

Document ID: 100

Document ID: 10

tutorial-01.pdf
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■3 Placing the document display
The following shows how to place the document display (object).

Step 1 Select [Object] → [Document Display] from the menu.
Step 2 Click the position where you place the document display. Placing the document display is completed.
Step 3 Double-click the document display which has been placed to display the setting dialog.

➟8.26.6 [Document Display] dialog
Step 4 Depending on the frame size of the placed document display object and the size of a target PDF or JPEG 

file, the display is changed as shown below.
The shaded area is displayed on the GOT.

More useful setting method
You can configure the object settings with the property sheet.

➟11.9 Checking and Editing Settings of Screens and Objects (Property Sheet)

(1) Image displayed on the document display object in GT Designer3
A sample image is previewed on the document display object in GT Designer3.
When the sample image is replaced with another image with the same file name, the new image is displayed.
The following shows the storage folders and file names of the sample images.

Document
to be displayed

Object frame

The display position is adjusted to 
the center in the vertical direction.

Document
to be displayed

Object frame

Document
to be displayed

Object frame

The display position is adjusted to 
the center in the vertical and 
horizontal directions.

The display position is adjusted to 
the center in the horizontal direction.

Document
to be displayed

Object frame

Item Description

Storage folder

The following folder contains the folders of display languages of GT Designer3.
[(Path to the installation location of GT Designer3)\GTD3_2000\App]
• Japanese: ja-JP
• English: en-US
• Simplified Chinese: zh-CN
When the display language is switched in GT Designer3, the folder to be referred to is also switched.

File name

Sample images are stored in the folder of each language.
• IMG00000L.JPG: Large size (816 dots × 1168 dots)
• IMG00000M.JPG: Medium size (656 dots × 928 dots)
• IMG00000S.JPG: Small size (400 dots × 584 dots)
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8.26.3 How to use the document display (for Document Converter output files)

The following shows how to display Document Converter output files on the document display.

■1 Procedure for displaying Document Converter output files
The following shows the procedure for displaying Document Converter output files.

For the details of the operations below, refer to the following.
• Converting files with Document Converter

➟■2 Converting documents to JPEG format with Document Converter
• Storing JPEG files on a data storage or file server

➟■3 Storing files on a data storage or file server
• Setting a document display object with GT Designer3

➟8.26.2 ■3 Placing the document display
8.26.6 [Document Display] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Document file

Document
(Word, Excel, 
PowerPoint)

PDF

Image data
(JPEG, BMP)

Document Converter (conversion to JPEG)

JPEG file

Document ID: 3
Document ID: 2

Document ID: 1

JPEG

GOT2000 (Document display)

GT Designer3 (Object setting)

Storing JPEG files

Writing the project 
data that contains 
the document display 
setting to the GOT

Connecting a 
data storage or 
file server 
to the GOT

Data storage or file server
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■2 Converting documents to JPEG format with Document Converter
The following shows how to convert a document to JPEG format with Document Converter.
Before using Document Converter, install the following software in the personal computer.

• Document Converter (Install it from the GT Works3 DVD (Disk3 folder).)
• Ghostscript GPL9.55 (Free software)

• PostScript printer driver supplied with Windows*1

• Microsoft Office 2003, Microsoft Office XP, Microsoft Office 2000*2

*1 Only the application for creating the document to be used is required.
*2 Required to convert a file created with Microsoft Word, Microsoft Excel, or Microsoft PowerPoint.

(1) Installing Document Converter
For how to install Document Converter, refer to the following.

➟GT Works3 Version1 Installation Procedure Manual
The following shows the operating environment for Document Converter.

*1 For installation, the standard user or administrator account is required.
To interact GT Designer3 with other MELSOFT applications which are used under the administrator authority, use GT 
Designer3 under the administrator authority.

*2 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Changing your desktop themes (fonts)
• Remote desktop
• Setting the size of text and illustrations on the screen to any size other than [Small-100%]

*3 Operation is not supported in an environment with the text cursor indicator turned on.
*4 The touch feature is not supported.
*5 Operation in a virtual environment such as Hyper-V is not supported.
*6 For execution, the hard disk space for storing the temporary data in conversion is required.

The required hard disk space is different depending on the document to be converted.
When the conversion fails, increase the hard disk space and convert the document again.

*7 Required to convert a file created with Microsoft Word, Microsoft Excel, or Microsoft PowerPoint.
*8 ARM6 and ARM32 are not supported.

Item Description

Model Personal computer that Windows runs on.

OS(English version)*1*2*3*4*5

• Microsoft Windows 11 Education (64 bit)
• Microsoft Windows 11 Enterprise (64 bit)
• Microsoft Windows 11 Pro (64 bit)
• Microsoft Windows 11 Home (64 bit)
• Microsoft Windows 10 Enterprise (32 bit, 64 bit)
• Microsoft Windows 10 Pro (32 bit, 64 bit)
• Microsoft Windows 10 Home (32 bit, 64 bit)

CPU
• Windows 11: 64 bit-compatible processor with dual-core or more or System on a Chip (SoC)*8

• Other than Windows 11: Intel Core 2 Duo Processor 2.0 GHz or more recommended*8

Memory
• For Windows 11: 4 GB or more recommended
• For 64-bit OS other than Windows 11: 2 GB or more recommended
• For 32-bit OS other than Windows 11: 1 GB or more recommended

Display Resolution SVGA (800 × 600 dots) or higher

Hard disk space
• For installation: 10 MB or more
• For execution: 100 MB or more recommended*6

Display color High Color (16 bits) or higher

Other software

To display Help, the following software must be installed.
• Internet Explorer7 or later recommended

The following software must be installed.
• Ghostscript GPL9.55 (Free software)

• PostScript printer driver supplied with Windows*7

• Microsoft Office 2003, Microsoft Office XP, Microsoft Office 2000*7

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD drive
• For execution: mouse, keyboard
• For printing: printer
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(2) Installing Ghostscript (Free software)
Download Ghostscript from the following website.
https://www.ghostscript.com/releases/gsdnld.html
Note that the above website may be changed without notification.

(a) Installing procedure
The following shows how to install Ghostscript GPL9.55 as an example.

Step 1 Execute the downloaded file.
Step 2 In the setup wizard, click the [Next] button.
Step 3 In the license agreement window, click the [I Agree] button.
Step 4 Select the installation destination, and click the [Install] button to start the installation.
Step 5 In the window notifying the completion of the installation, select options as necessary and click the [Finish] 

button.

(b) Adding environment variables
When setting [C:\gs] as the installation destination, add [C:\gs\******\bin] and [C:\gs\******\lib] to the path of environment 
variables after the installation is completed.
Input six characters consisting of upper five digits of the installation execution file name and a decimal number to ******.
(For gs9550w64.exe, input gs9.55.)
The following shows the procedure for setting environment variables.

Step 1 Select [Start] → [Control Panel] → [System and Security] → [System] from the menu.
Step 2 Click the [Change settings] button in [Computer name, domain, and work group settings].
Step 3 Select the [Advanced] tab and click the [Environment Variables] button.
Step 4 Select [Path] in [System variables], and then click the [Edit] button.

Step 5 Click the [New] button in the [Edit environment variable] dialog and add the path.
There is no need to add a semicolon (;).

Step 6 Restart the personal computer.
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(3) PostScript printer driver
The following shows how to install the PostScript printer driver.
For the detail of the operation of Windows, refer to the manual or help of Windows.

Step 1 Select [Start] → [Control Panel] → [Hardware and Sound] → [Add a printer] from the menu.
Step 2 Click [The printer that I want isn't listed], select [Add a local printer or network printer with manual settings], 

and click [Next].

Step 3 Select [FILE: (Print to File)] for [Use an existing port], and click [Next].

Step 4 Select the PostScript printer driver (manufacturer: Generic, printer: MS Publisher Color Printer) supplied 
with Windows, and click [Next].
8. OBJECT FUNCTION
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Step 5 Select [Use the driver that is currently installed], and click [Next].

Step 6 Check [Printer name], and click [Next].

Step 7 Select [Do not share this printer], and click [Next].
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Step 8 Click the [Finish] button.

(4) Conversion procedure
The following shows the conversion procedure.

Step 1 Start Document Converter.
When Ghostscript runs with administrator privileges, use Document Converter with administrator privileges 
as well.
For how to run the software with administrative privileges, refer to the following.

➟Manual and Help for the Windows version used
Step 2 The [Document Converter] dialog appears.

Set the following items.

1) [Document ID]
Set the document ID for the converted document.
The setting range is [1] to [32767].

2) [Document Name]
Set the name for the converted document.

1)
2)
3)
4)

5)

6)

7) 8) 9)
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The name is displayed in GT Designer3 (such as the data view or property sheet) and in the operation log.
Up to 32 characters can be set.

3) [File Path]
Clicking the [Browse] button to specify the path name of the file to be converted.

4) [Output Path]
Set the output destination (path) of the converted file.
The following shows the folders and files after the path which can be set.
(Output path)\DOCIMG\(Document ID)\(Output size: L, M, or S)\IMG*****.JPG
As the output size, L means large, M means medium, and S means small.
***** is the page No.
Example) When [Document ID] is set to [1] and [Size] is set to [L]
(Output path)\DOCIMG\001\L\IMG00001.JPG

5) [Output Page]
Set the page to be converted.
Set this item when the file to be converted is Word, Excel, PowerPoint, or PDF file.

6) [Output Page Head Number]
Set the head number of the pages to be converted.
The setting range is [1] to [65535] page(s).

7) [Convert] button
Starts conversion.

8) [Close] button
Closes the [Document Converter] dialog.

9) [Quality] button
Set the image quality of the document.
The setting is applied to the converted document.

➟(5) Quality adjustment procedure
Step 3 After the setting, click the [Convert] button.

The conversion starts.
After the conversion, the JPEG file is created in three sizes (large, medium, small) for each page.
The following shows the size of a JPEG file converted from an A4-size document.

• Large: 816 dots × 1168 dots
• Medium: 656 dots × 928 dots
• Small: 400 dots × 584 dots
8 - 698 8. OBJECT FUNCTION
8.26 Placing a Document Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

(5) Quality adjustment procedure
The following shows the quality adjustment procedure.

Step 1 Start Document Converter.
Step 2 The [Document Converter] dialog appears.

Click the [Quality] button.
Step 3 The [Quality] dialog appears.

Set the following items.

1) Page list
Displays the thumbnails for each page.
Select the page whose image quality is to be adjusted from this list.
When [Paginal] is set for [Quality], select the page.

2) Preview window
Displays the preview of the image.
The preview before the quality adjustment is shown in the left window.
The preview after the quality adjustment is shown in the right window.

3) [Adjust quality per image size]
Set this item to adjust the image quality per image size.
Select the image size to be adjusted at [Size].

4) [Size]
Select the image size to be adjusted.
Select the size every time an image in different size is to be adjusted.
The following shows selectable items.

• [Large]
• [Medium]
• [Small]

Set this item when [Adjust quality per image size] is set.
5) [Display Type]

Select a display type at the preview window.
The following shows selectable items.

• Actual size
• Entire page
• Fitted to the width

6) [Quality]
Set this item to adjust the image quality.
Select the method of adjustment.
The following shows selectable items.

• [All]:
Select this item to apply the same adjustment to all pages.

• [Paginal]:

1) 2)

3)

7)

4), 5)

6)

8)
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Select this item to adjust the image quality per page.
Select the page to be adjusted from the page list and set [Enable quality adjustment] to adjust the selected 
page.

7) [Adjust] button
Executes the set quality adjustment.
Note that the setting cannot be restored after the execution.

8) [Cancel] button
Cancels the set quality adjustment and closes the dialog.

Step 4 After the setting, click the [Adjust] button.
The [Quality] dialog is closed and the setting of the quality adjustment is completed.

■3 Storing files on a data storage or file server
In the root directory of a drive, create a folder named "DOCIMG".
Do not change the hierarchical structure of the folders and files in the DOCIMG folder.
Doing so cause the GOT not to recognize the files.

Image files required when the the graphics accelerator is enabled
When the graphics accelerator is enabled, only large image files are used.
You do not need to store folder M or S, which contains medium or small image files, on the drive.
For the graphics accelerator, refer to the following.
➟8.26.4 ■1 Enlarging or reducing the display of a document

Item Description

[Reset] button Clears the setting of [Quality].

[Brightness] Set the value of brightness.
The setting range is [-100] to [100].

[Contrast] Set the value of contrast.
The setting range is [-100] to [100].

[Sharpness] Set the value of sharpness.
The setting range is [-100] to [100].
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8.26.4 Operating the document display

The following shows how to operate the document display.

■1 Enlarging or reducing the display of a document
On the GOT, you can enlarge or reduce the display of a document on the document display object.
The frame size of the document display object remains unchanged even though the display of the document is enlarged 
or reduced.

When the display of a document is enlarged or reduced, the display varies depending on the document type.
• When the document type is set to [Document Converter Output File]

The document size is switched to large, medium, or small.

• When the document type is set to [PDF File]
The document size is enlarged or reduced by using the large size (100% magnification) as the reference.

When the document size is enlarged or reduced with the object gesture function, a magnification of 25% to 400% is 
used.
When the document size is enlarged or reduced with a key code switch, one of the following magnifications is used.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2

200%25% 100%
(Full scale)

400%

Magnification (%)

25 15037.5 50 62.5 75 87.5 100 125 200 400
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When the display of a document is enlarged or reduced, the display varies depending on the document type and the 
graphics accelerator setting.

➟5.1.5 [Type Setting] dialog
• When the document type is set to [Document Converter Output File] and the graphics accelerator is disabled

The document size is switched to large, medium, or small.

• When the document type is set to [PDF File] or when the document type is set to [Document Converter Output File] 
and the graphics accelerator is enabled
The document size is enlarged or reduced by using the large size (100% magnification) as the reference.

When the document size is enlarged or reduced with the object gesture function, a magnification of 25% to 400% is 
used.
When the document size is enlarged or reduced with a key code switch, one of the following magnifications is used.

GOT Graphic Ver.1

200%25% 100%
(Full scale)

400%

Magnification (%)

25 15037.5 50 62.5 75 87.5 100 125 200 400
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■2 Operating method of the document display
The following shows how to operate the document display.

➟(1) Operations by using touch switches
(2) Operations by using the object gesture function
(3) Page switching by using a device
(4) Using bookmarks
(5) Keyword search in the [Search] window
(6) Key window for entering a search string

(1) Operations by using touch switches
Using touch switches where the key codes for the document display are set, operate the document display.
Touch switches for the document display are available by reading from the library of GT Designer3.
The characters and shapes on the touch switches can be changed by a user.
When key codes are set for touch switches, touch switches for the document display can be created by a user.

Touch switch Key code Description

Next page

FFE0h

Moves to the next page or previous page.

When the page No. is specified using a device, the device value is changed according to the key 
operation.

Previous page

FFE1h

Object frame

Document to be displayed

Touch switch for 
the document display

GOT2000 
manual

1-1

GOT1000
manual

1-1

Safety ...

1-2
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(2) Operations by using the object gesture function
The display of objects can be operated using gestures.
For operations with gestures, refer to the following.

➟11.13 Operating Objects by the Gesture (Object Gesture Function)

Expansion

FFE2h

Enlarges or reduces the display of a page.
When the display of a document is enlarged or reduced, the display is changed depending on the 
document type and the graphics accelerator setting.
For the setting details, refer to the following.

➟■1 Enlarging or reducing the display of a document

Reduction

FFE3h

Up Scroll

FFE4h

Scrolls the page either upward or downward.

When the top or bottom of the page is displayed, or the vertical size of the document is smaller than 
the object frame size (at vertical centering display), the keys do not work.

Down Scroll

FFE5h

Left Scroll

FFE6h

Scrolls the page either left or right.

When the left end or right end of the page is displayed, or the vertical size of the document is smaller 
than the object frame size (at horizontal centering display), the keys does not work.

Right Scroll

FFE7h

Touch switch Key code Description

GOT1000
manual

1-1

GOT1000
manual

1-1

GOT 1

Man

2000
ual

GOT20
Manua
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(3) Page switching by using a device
You can control the page displayed on the document display by using a device.
In the [Document Display] dialog, select [Device] for [Page No.] and set [Device].

➟8.26.6 [Document Display] dialog

Changing the set device value switches the page displayed on the document display.
Example) When [Document Type] is [Document Converter Output File], [Initial Display Size] is [Large], [Document ID] is 
[2], and [Device] is [D600]

(4) Using bookmarks
This function is available only when [Document Type] is set to [PDF File].
Touching a bookmark displays the linked page.
Up to 1000 bookmarks in 10 levels are displayable.
For a PDF file without bookmarks, nothing is displayed in the [Bookmark] window.
For the setting to use the [Bookmark] window, refer to the following.

➟8.26.6 [Document Display] dialog
The following shows how to operate the [Bookmark] window on the GOT.

Step 1 Touch a document display object to display the Bookmark button.
If no operation is performed within a certain time period, the Bookmark button is hidden.

D600=2

Page 2

D600=4

Page 4

(DOCIMG\002\L)

Page 1

Page 2

Page 3

Page 4

IMG00001.JPG

IMG00002.JPG

IMG00003.JPG

IMG00004.JPG

Document ID: 2
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Step 2 Touch the Bookmark button to display the [Bookmark] window.

1) Search button
Switches to the [Search] window.

2) [×] button
Closes the [Bookmark] window.

3) Bookmarks
Touch a bookmark to display the linked page.
To expand a bookmark, touch [+] beside the bookmark.
In this case, only the bookmark and its child bookmarks are listed.
To return to the parent level, touch [-] beside the bookmark.

Touch the document display object. Touch the Bookmark button.

4)

1) 2)

3)
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4) Change Window Width button
Changes the width of the [Bookmark] window.

(5) Keyword search in the [Search] window
This function is available only when [Document Type] is set to [PDF File].
In the [Search] window, enter a keyword to search for in a PDF file.
The following strings cannot be searched for.

• String split across a page boundary
• One-byte string split over two lines
• Bookmark or annotation

For the setting to use the [Search] window, refer to the following.
➟8.26.6 [Document Display] dialog

The following shows how to operate the [Search] window on the GOT.
Step 1 Touch a document display object to display the Search button.

If no operation is performed within a certain time period, the Search button is hidden.

Step 2 Touch the Search button to display the [Search] window.

1) Bookmark button
Switches to the [Bookmark] window.

Touch [+] beside section 1.1.

Touch the document display object. Touch the Search button.

7)

4)

1) 2)

5)

6)

3)
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2) [×] button
Closes the [Search] window.

3) Search string entry field
Touch the entry field to display the key window for entering a search string.

➟(6) Key window for entering a search string
Enter a string and touch the [ENTER] key in the key window to perform a search.
The search is case-sensitive and only returns exact matches.
Up to 47 Unicode characters can be entered.
The 48th and subsequent characters are deleted when the [Enter] key is touched.

4) Search History button
Lists up to 10 strings which are recently searched for.
Select a string from the search history to perform a search.
In this case, the selected string becomes the last-used one and moves to the top of the search history.
When the Disable Search History Update signal (GS523.b1) is on, the search history does not updates.
However, you can still perform searches using the strings in the search history.

5) [Prev] button
Searches for the previous instance of a string from the current page.

6) [Next] button
Searches for the next instance of a string from the current page.

7) [Cancel] button
Cancels the search.

(6) Key window for entering a search string
Enter a string to perform a search in the [Search] window.
For the basic operations of a key window, refer to the following.

➟5.2.4 Setting key windows ([Key Window])

1) Convert key
This key is usable only when the system language is Japanese and the kana input is used.
Converts a group of hiragana characters to kanji characters.
If you touch this key during the conversion, the converted characters will be restored to their original state.

2) Select key
This key is usable only when the system language is Japanese.
Confirms the entry.

Up to 40 one-byte or 20 two-byte characters can be entered at one time.
To enter a longer string, touch the Select key before the number of the entered characters exceeds the above limit, 
and then enter the rest of characters.
When you convert multiple groups of hiragana characters, confirm each group of characters with the Select key.

3) Previous key or Next key
This key is usable only when the system language is Japanese and the kana input is used.
Converts a group of hiragana characters to kanji characters.
Switches between kanji conversion candidates.

4) Cursor keys
The behavior of the keys differs depending on the status of the entry.

2)

5)

1)

4)

3)

Key window in alphabet mode Key window in kana mode

Before the entry is confirmed After the entry is confirmed
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• Before the entry is confirmed
The keys change the range of the characters to be converted.
After the change, perform a conversion.

• After the entry is confirmed
The keys move the cursor.

5) [Enter] key
Executes a search based on the entered string.

■3 Specifying the first page to appear by keyword searching
This function is available only when [Document Type] is set to [PDF File].
If screens are switched or the display conditions are satisfied, the document display object appears, and then the 
specified keyword is searched for in the document.
The document display object displays the page on which the first occurrence of the keyword is found.
To enable this function, select [Specify the display page with a keyword] in the [Document Display] dialog.

➟8.26.6 [Document Display] dialog

A search is performed to find only the first hit when the document display object is displayed.
The hit will be highlighted.
No notification will be provided if an error occurs.
To go to another hit or to receive error notifications, enable the search control with devices.

➟(1) Controlling the search with devices
The following strings cannot be searched for.

• String split across a page boundary
• One-byte string split over two lines
• Bookmark or annotation

To specify a search keyword, select one of the following methods.
• Specifying a registered comment as the keyword

Specify a comment to search for with a comment group number, comment number, and comment column number.
Specify each number directly or with a device.

➟5.8 Comment Setting ([Comment])
• Storing a string to be the keyword in devices

Use the string stored in devices as the keyword.
Up to 47 characters are usable in the string.
Set how to specify the keyword in the [Setting] dialog.

➟8.26.6 ■1 [Setting] dialog (Search settings for the document display object)

The following shows an example of specifying a comment as the keyword.
Example) Using a switch to display a window screen on which a document display object is placed
Place a document display object on window screen 1, select [Specify the display page with a keyword], and configure the 
following settings in the [Setting] dialog.

• [Keyword]: [Comment]
• [Comment Group No.]: 1
• [Comment No.]: Value of D1000
• [Comment Column No.]: 1

Place a switch on base screen 1, and configure the settings on the [Action] tab so that the following operations are 
performed.

• [Word Set]: Storing comment No. 1 in D1000
• [Screen Switching]: Displaying window screen 1 as overlap window 1

Touching the switch displays overlap window 1.
The document display object displays the page on which the first hit is found.
8. OBJECT FUNCTION
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(1) Controlling the search with devices
To control the search and receive search-related notifications, use the search control device and the search status 
notification device.

• To start or abort a search, use the search control device.
• To receive notification of a search state or an error, use the search status notification device.

To set the devices, select [Control the search] in the [Setting] dialog.
For the function of each bit of the devices, refer to the following.

Touch the switch. Overlap window 1 appears, displaying the 
page on which the first hit is found.

AAAA

Comment group No. 1

BBBB

1

2

Comment No.
Comment column No.

1

AAAA

Comment specified as the keyword
・ Comment group No.: 1
・ Comment No.: 1 (Value of D1000)
・ Comment column No.: 1
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➟8.26.6 ■1 [Setting] dialog (Search settings for the document display object)
If this search control is enabled, a search will not be performed automatically when a document display object is 
displayed.
To start a search, turn on the search trigger device (b0 of the search control device).

The following shows an example of controlling the search with the devices.
Example) Finding a hit after the document display object displays the page on which the first hit is found
Configure the following settings.

Touching the switch displays overlap window 1.
The document display object displays the page on which the first hit is found.
Touching the Previous or Next switch goes to the previous or next hit, starting from the first hit.

Item Object or function Setting

Common setting Screen script

For window screen 1, set a screen script so that turning on the device notifying that 
a search is in progress (D3000.b0) turns off the search trigger device (D2000.b0).
• [Trigger Type]: [Ordinary]

Base screen 1 Switch

Switch to display the screen on which a document display object is placed.
On the [Action] tab, configure the settings so that the following operations are 
performed.
• [Word Set]: Storing comment No. 1 in D1000
• [Bit Set]: Turning on the search trigger device (D2000.b0)
• [Screen Switching]: Displaying window screen 1 as overlap window 1

Window screen 1

Document display object

Select [Specify the display page with a keyword], and configure the following settings 
in the [Setting] dialog.
• [Keyword]: [Comment]
• [Comment Group No.]: 1
• [Comment No.]: Value of D1000
• [Comment Column No.]: 1
• [Control the search]: Selected
• [Search Control Device]: D2000
• [Search Status Notification Device]: D3000

Switch (Previous)

Switch to go to the previous hit.
On the [Action] tab, configure the settings so that the following operations are 
performed.
• [Bit Set]: Turning on the device that reverses the search direction (D2000.b1)
• [Bit Set]: Turning on the search trigger device (D2000.b0)

Switch (Next)

Switch to go to the next hit.
On the [Action] tab, configure the settings so that the following operations are 
performed.
• [Bit Set]: Turning off the device that reverses the search direction (D2000.b1)
• [Bit Set]: Turning on the search trigger device (D2000.b0)

if([b:D3000.b0] == 1){
 [b:D2000.b0] = 0;
}
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Even while the [Search] window is being displayed, you can perform a search using the search control device.
In this case, the entered keyword and buttons in the [Search] window are unusable.
If you perform a search using the search control device while a search in the [Search] window is in progress, the search 
will start upon completion of the search in progress.

AAAA

Comment group No. 1

BBBB

1

2

Comment No.
Comment column No.

1 Comment specified as the keyword
・ Comment group No.: 1
・ Comment No.: 1 (Value of D1000)
・ Comment column No.: 1

AAAA AAAA

Touch the switch. Touch the Next switch. The page on which the 
next hit is found appears.

Previous Next Previous Next
8 - 712 8. OBJECT FUNCTION
8.26 Placing a Document Display



8

O
B

JE
C

T 
FU

N
C

TI
O

N

8.26.5 Precautions for a document display object

This section explains the precautions for the document.

■1 When the page is switched to a nonexistent page
When a nonexistent page is specified at switching the page, no document is displayed.
The Document Display Status Notification signal (GS276.b0) turns on.

■2 When a document is not displayable
In the following cases, a document is not displayable on the document display object.
The Document Error signal (GS276.b0) turns on when a document is not displayable.

• The specified file is nonexistent.
• The type of the specified file differs from the set document type.
• The specified file is corrupt.
• No data storage is installed.
• The data storage is unformatted.
• No file server is connected.
• The file server is turned off.
• The SD card cover of the GOT is open.
• The SD card access switch of the GOT is turned off.
• A nonexistent document ID number or page number is specified.
• The size of a JPEG file exceeds the size of 1240 dots × 840 dots or 840 dots × 1240 dots.
• The size of a JPEG file converted with Document Converter exceeds 960 KB.
• The specified PDF file is not supported.
• The specified PDF file is password-protected.
• A page in the specified PDF file contains a large image file.

A document that contains a large image file may not be displayed.
Create a PDF file that does not contain a large image file.

• The page size (paper size) of the specified PDF file is large.
Create a PDF file with a reduced page size.

• A page in the specified PDF file contains many figures and objects.
Create a PDF file with reduced number of figures and objects in a page.

■3 When a document cannot be cached to display
A document cannot be cached to display in the following cases.
The Cache Invalidated signal (GS276.b1) turns on when the cache is unavailable.

• The data storage or file server is write-protected.
• The data storage or file server has insufficient free space.
• The data storage or file server is faulty.
• The Invalidate Cache signal (GS523.b0) is on.

■4 Restrictions when the graphics accelerator setting and the display order setting are both 
configured

When the following settings are both configured in the [Type Setting] dialog, the GOT has restrictions on its operations.
• [Enable the graphics accelerator to smooth the screen gesture and document display operations] is selected.
• [Adjust object display order in GOT to the one in GT Designer3] is selected.

(1) Refresh stop of the object display
While the document display is being operated, the displays of the other objects are not refreshed.

(2) Functions that do not operate normally
While the document display is being operated, some functions may not operate normally.
Do not use the following functions simultaneously with the document display.

• Free figure drawing function of the object script
• Parts display ([Display Mode]: [Overwrite])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.1
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• Scatter graph ([Display Mode]: [Locus])

■5 PDF file which cannot be converted
When the font used in the PDF file is in either of the following statuses, the PDF file cannot be used for the document 
display.

• The font does not exist in the operating environment (in Windows).
• The font information is not embedded in the PDF file.

In the above cases, an error occurs at the conversion using Document Converter.
Convert the page which cannot be converted using Document Converter in the following procedure.

Step 1 Select [Page] for [Output Page] and execute the conversion.
Step 2 Check the page which cannot be converted with the error message.
Step 3 Capture the image of the page which cannot be converted, and save the captured image as an image file 

(JPEG or BMP).
Step 4 Convert the saved image file (JPEG or BMP) using Document Converter.

■6 Sharing a PDF file on the network drive with multiple GOTs
In the folder containing the PDF file, a search history file is created with the same filename as the PDF file.
If multiple GOTs share a PDF file on the network drive, the search history file is updated with the data of the last GOT 
that performed a search.
To disable updating of the search history file, turn on GS523.b1.
8 - 714 8. OBJECT FUNCTION
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8.26.6 [Document Display] dialog

The document display is an object that displays documents created with a personal computer (such as Microsoft Word, 
Microsoft Excel) on the GOT.

Step 1 Select [Object] → [Document Display] from the menu.
Step 2 Click the position where you place the document display. Placing the document display is completed.
Step 3 Double-click the document display which has been placed to display the setting dialog.

1) [Document Type]
Select the type of a document to be displayed on the document display object.
The following shows selectable items.

• [PDF File]
Displays a PDF file as it is.
For the storage location of the PDF files, refer to the following.
➟8.26.2 ■2 Storing files on a data storage or file server

• [Document Converter Output File]
Displays a JPEG file that is converted from a document in another format with Document Converter.
For the storage location of the JPEG files, refer to the following.
➟8.26.3 ■3 Storing files on a data storage or file server

2) [Storage Drive]
Select a location to store files to be displayed on the document display object.
The following shows selectable items.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

4)

7)

8)
9)

11)
10)

6)

12)

2)

5)
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3) [Initial Display Size]
Select the initial size of the document display to be displayed at screen switching.
The following shows selectable items.

The selection for [Document Type] determines the GOT operation.
When the document type is set to [PDF File]

• [Large]: Displays a large PDF file at 100% magnification.
• [Medium]: Displays a large PDF file at 75% magnification.
• [Small]: Displays a large PDF file at 50% magnification.

When the document type is set to [Document Converter Output File]
• [Large]: Displays a large JPEG file.
• [Medium]: Displays a medium JPEG file.
• [Small]: Displays a small JPEG file.

The selection for [Document Type] and the graphics accelerator setting determine the GOT operation.
➟5.1.5 [Type Setting] dialog

When [Document Type] is set to [PDF File] or [Document Converter Output File] and the graphics accelerator is 
enabled

• [Large]: Displays a large PDF file or JPEG file at 100% magnification.
• [Medium]: Displays a large PDF file or JPEG file at 75% magnification.
• [Small]: Displays a large PDF file or JPEG file at 50% magnification.

When [Document Type] is set to [Document Converter Output File] and the graphics accelerator is disabled
• [Large]: Displays a large JPEG file.
• [Medium]: Displays a medium JPEG file.
• [Small]: Displays a small JPEG file.

4) [Page Settings]

Item Description

[Document ID]

Select how to set a document ID.
If an nonexistent document ID is set, no document is displayed.The following shows the 
items to be selected.
• [Fixed]:

Sets the document ID by entering a number directly.
Set the document ID of the document to be displayed first at screen switching.
The setting range is [1] to [32767].

• [Device]:
Sets the document ID by specifying a device value.
Set a device that specifies the document ID.
➟6.1.2 How to set devices

[Page No.]

Select how to set the page to be displayed.
The following shows the items to be selected.
• [Fixed]:

Sets the page number by entering a number directly.
Set the number of a page to be displayed first upon screen switching.
The setting range is [0] to [65535].

• [Device]:
Select this item to specify a page No. with the device value.

• [Data Type]
Select a data type of the word device.
The following shows selectable items.
·[Unsigned BIN16]
·[BCD16]

• [Device]
Set a device that specifies the page number.
➟6.1.2 How to set devices

GOT Graphic Ver.2

GOT Graphic Ver.1
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5) [Specify the display page with a keyword]
This item is selectable when [Document Type] is set to [PDF File].
Displays the page on which the first occurrence of the specified keyword is found.

➟8.26.4 ■3 Specifying the first page to appear by keyword searching
Click the [Setting] button to display the [Setting] dialog.

➟■1 [Setting] dialog (Search settings for the document display object)
6) [Use the search/bookmark function]

This item is selectable when [Document Type] is set to [PDF File].
Select this item to use the search in the [Search] window or the bookmark function.

➟8.26.4 ■2 (4) Using bookmarks
8.26.4 ■2 (5) Keyword search in the [Search] window

In the [Environmental Setting] window ([Screen Switching/Window]), select [Use also as a system window] for the 
overlap window to be used as a system window.

➟5.2.1 ■5 [Screen Switching/Window]
7) [Notification Setting]

8) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
9) [User ID]

Select this item to set the user ID.
The setting range is [1] to [65535].

10) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
When the set device is in either the ON or OFF status, select whether or not to display the object.
The following shows selectable items.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

11) [Layer]
Select the layer to arrange the object on.
The following shows selectable items.

• [Front]
• [Back]

12) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

Item Description

[Display Status Notification Device]

Set a device that notifies the display status of a document.
The device stores any of the following values according to the display status of the 
document.
• 0: Normal
• 1: The specified file is nonexistent or exceeds 3 MB.

The data storage or file server is inaccessible.
• 2: The specified file is not an image file or is corrupt.
• 3: The specified document ID is outside the range of 1 to 32767, or the specified 

document is nonexistent.
• 4: A nonexistent page number is specified.
• 101: The specified PDF file is nonexistent.

The data storage or file server is inaccessible.
• 102: The specified PDF file is not supported or is corrupt.
• 103: The document ID of the specified PDF file is outside the range of 1 to 32767, or no 

PDF file corresponds to the document ID.
• 104: The specified page number is nonexistent in the target PDF file.
• 105: The specified PDF file is password-protected.
• 107: The data size of a page in the specified PDF file exceeds 30 MB.

[Last Page No. Notification Device] Set a device that notifies the last page number of the document corresponding to a 
specified document ID.
8. OBJECT FUNCTION
8.26 Placing a Document Display

8 - 717



■1 [Setting] dialog (Search settings for the document display object)
Set how to specify a keyword to search for in the document, and set devices to control the search.

1) [Keyword]
Select how to specify a search keyword.
The following shows selectable items.

• [Comment]
Uses a comment registered in a comment group as the keyword.
➟5.8 Comment Setting ([Comment])

If the specified comment has 48 or more characters, the first 47 characters are used as the keyword.
• [Device]

Uses the string stored in devices as the keyword.
2) Keyword settings

The setting items vary according to the selection for [Keyword].
For the details, refer to the following.

➟(1) When specifying a comment as the keyword
(2) When specifying the string stored in devices as the keyword

3) [Control the search]
Controls the search and receives search-related notifications with devices.
Set [Search Control Device] and [Search Status Notification Device].

4) [Search Control Device]
Set a device to control the search.
The following shows the function of each bit of the set device.

5) [Search Status Notification Device]
Set a device that notifies a search state.
The following shows the function of each bit of the set device.

Bit number Function

b0
Turn on this bit to start searching for the specified keyword.
If a document display object is displayed while this bit is on, a search will start.
Make sure to turn off this bit if b0 of the search status notification device is turned on.

b1
Switches between the search directions.
While this bit is on, turning on b0 of the search control device goes to the previous hit.

b2
Turn on this bit to abort the search in progress.
Make sure to turn off this bit.

b3 to b15 Use prohibited

Bit number Function

b0

This bit is turned on when b0 of the search control device is turned on to start a search.
This bit is turned off when the search in progress is completed and b0 of the search control device is turned off.
This bit is turned off when the document display object is hidden because of screens being switched or other 
events.

2)

1)

3)

5)

4)
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(1) When specifying a comment as the keyword
Set how to specify a comment group number, comment number, and comment column number.

1) [Comment Group No.]
Select how to specify a comment group number.
The following shows selectable items.

• [Fixed]
Specify a comment group number directly.
The setting range is [1] to [500].
If the specified comment group number is nonexistent, a search will not be performed.

• [Device]
Specify a comment group number with a device.
Select this item, and specify a device.
If the specified comment group number is nonexistent, a search will not be performed.
If a value outside the range of 1 to 500 is specified, it is assumed to be 1.

2) [Comment No.]
Select how to specify a comment number.
The following shows selectable items.

• [Fixed]
Specify a comment number directly.
The setting range is [1] to [32767].
If the specified comment number is nonexistent, a search will not be performed.
Click the [Edit] button to display the [Edit Comment] dialog.
For the details of the [Edit Comment] dialog, refer to the following.
➟12.15.4 [Edit Comment] dialog

• [Device]

b1

This bit is turned on when the search returns to the first hit.
This bit is turned off when b0 of the search control device is turned on to start a search.
This bit is turned off when the document display object is hidden because of screens being switched or other 
events.

b2

This bit is turned on when the search returns no hits.
This bit is turned off when b0 of the search control device is turned on to start a search.
This bit is turned off when the document display object is hidden because of screens being switched or other 
events.

b3 to b13 Use prohibited

b14

This bit is turned on when no keyword is specified, such as in the following cases.
• The comment to search for is nonexistent.
• The specified devices store no string to search for.
This bit is turned off when b0 of the search control device is turned on to start a search.
This bit is turned off when the document display object is hidden because of screens being switched or other 
events.

b15

This bit is turned on if the search fails.
This bit is turned off when b0 of the search control device is turned on to start a search.
This bit is turned off when the document display object is hidden because of screens being switched or other 
events.

Bit number Function

2)

1)

3)
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Specify a comment number with a device.
Select this item, and specify a device.
If the specified comment number is nonexistent or a value outside the range of 1 to 32767 is specified, a search 
will not be performed.

3) [Comment Column No.]
Select how to specify a comment column number.
The following shows selectable items.

• [Change with language switching device]
Specifies the value of the language switching device as the comment column number.
If the specified comment column number is nonexistent or a value outside the range of 1 to 30 is specified, a 
search will not be performed.
If [Display] is selected for [Alternative Display (when the language switching device value is out of the range 
(1-30) or comment column No. does not exist)], a comment in the specified comment column is used as the 
keyword.
For the setting details, refer to the following.
➟5.2.2 ■4 [Language Switching]

5.8.4 ■2 Creating a new comment group
• [Fixed]

Specify a comment column number directly.
The setting range is [1] to [30].
If the specified comment column number is nonexistent, a search will not be performed.

• [Device]
Specify a comment column number with a device.
Select this item, and specify a device.
If the specified comment column number is nonexistent, a search will not be performed.
If a value outside the range of 1 to 30 is specified, it is assumed to be 1.

(2) When specifying the string stored in devices as the keyword
Set consecutive devices that store a string to search for.

1) [Keyword Device]
Specify the first device of consecutive devices that store a string to search for.
As many devices as the set value of [Character Count] are used.

2) [Character Code]
Set the character code of a string.
The following shows selectable items.

• [System Language Link]
• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS]
• [Big5]

3) [Character Count]
Specify the maximum number of characters in a string.

2)

1)

3)
4)
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The setting range is [1] to [47].
4) [Data Reading Order]

Select the order in which data is read from the specified devices.
• [Low --> High]
• [High --> Low]

8.26.7 Relevant settings

Set the relevant settings other than the specific settings for the document display as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Enabling the gesture function [Use the gesture function]

Smoothing the operations of the document display
[Enable the graphics accelerator to smooth the screen gesture and 
document display operations]

GOT Graphic Ver.1

Function Setting item

Checking if the document is displayed.
(Write device)

GS276.b0

Notifying that a PDF file cannot be cached to display.
(Write device)

GS276.b1

Notifying the display quality when a PDF document is displayed
(Write device)

GS276.b2

Notifying that the display size of the document has been changed by GS523.b3.
(Write device)

GS276.b3

Displaying a PDF file without caching the file.
(Read device)

GS523.b0

Using the PDF search function without creating or updating the search history file.
(Read device)

GS523.b1

Displaying a PDF document in high quality
(Read device)

GS523.b2

Fitting the displayed PDF document to the object width.
(Read device)

GS523.b3
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8.27 Placing a Video/RGB Display Object

Not available to GT2705-V.
Displaying video images will be supported soon.
The video/RGB display object displays an RGB image on a base screen or window screen.
You can specify the exact display position of an input image just by placing a video/RGB display object on a screen, which 
is unavailable with the video/RGB display function.
The display magnification, rotation angle, inversion, and others are also settable, displaying an RGB image in various 
ways.

RGB input unit applicable to the video/RGB display object
Use GT27-R2 for the video/RGB display object.
GT27-R2-Z or GT27-V4R1-Z is not applicable.
When using GT27-R2-Z or GT27-V4R1-Z, use the RGB display function.
➟10.7 Displaying Image from a Personal Computer on the GOT (RGB Display Function)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

RGB image

The RGB image is displayed in 
the position where the video/RGB 
display object is placed on a base 
screen or window screen.
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8.27.1 Specifications of the video/RGB display object

■1 System application (extended function)
To use the video/RGB display object, a system application (extended function) of [Video/RGB (Object)] is required.
To incorporate the application into package data automatically, select [Use Video/RGB Input] and select [GT27-R2 (RGB 
Screen only)] for [Unit Type Name] in the [Video/RGB Input] dialog.

■2 Required version of BootOS
To use GT27-R2, install version N or later of BootOS on the GOT.

➟4.3.2 Transferring data

■3 Resolution and refresh rate
The video/RGB display object supports the following resolutions and refresh rates.

■4 Applicable channel
The video/RGB display object can display an image input from the following channels.

■5 Maximum number of objects that can be placed on one screen
Up to four video/RGB display objects can be placed on one screen.
The GOT can simultaneously display up to four video/RGB display objects placed on base screens and window screens.
The other video/RGB display objects are not displayed.
Configure the setting so as to display up to four video/RGB display objects placed on base screens and window screens 
simultaneously.

■6 Applicable screen
The video/RGB display object can be placed on the following screens.

• Base screen
• Overlap window
• Superimpose window
• User-created key window
• Dialog window

■7 Size of the video/RGB display object
The position and size (width and height) of the video/RGB display object are settable in units of 4 dots.
The settable size range is 64 by 64 dots to 1280 by 1024 dots.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Resolution Refresh rate (Hz)

XGA(1024×768 dots) 60

SVGA(800×600 dots) 60/72/75

VGA(640×480 dots) 60/72/75/85

Input signal Number of applicable 
channels Applicable channel number

RGB input 2 CH1, CH2
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■8 Displaying an input image
Input images are displayable in various ways by using the video/RGB display object.
For the details of the setting method, refer to the following.

➟8.27.4 [Video/RGB Display] dialog

(1) Display magnification
You can change the display magnification of an input image.
[Fixed], [Device], and [Auto-resizing] are selectable to specify the display magnification.
For [Fixed], the following magnification factors are selectable: [400], [200], [100], [87.5], [75], [62.5], [50], [37.5], or [25] 
(%).

For [Device], the display magnification depends on the device value as shown below.

*1 When the object gesture function is enabled, the magnification range of 25% to 400% is applied.
When the object gesture function is disabled, the magnification of 100% is applied.

For [Auto-resizing], an input image is displayed according to the size of a video/RGB display object.
When the aspect (length-to-width) ratios differ between an input image and a video/RGB display object, the image is 
enlarged or reduced to the object size with the image aspect ratio unchanged.

Device value Display magnification

0 100%

1 87.5%

2 75%

3 62.5%

4 50%

5 37.5%

6 25%

7 400%

8 200%

9 to 24 100%

25 to 400*1 25% to 400%, or 100%

401 or more 100%

400％ 100% 25％

・ ・ ・ ・ ・ ・ ・ ・
Input image

The input image is enlarged or reduced 
to the object size.

Input image
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(2) Rotation angle
You can rotate an input image in units of 90 degrees.
[Fixed] and [Device] are selectable to specify the rotation angle.
For [Fixed], the following rotation angles are selectable: [None], [90 degrees to the right], [180 degrees], and [90 degrees 
to the left].

For [Device], the rotation angle depends on the device value as shown below.

(3) Inversion
You can invert an input image horizontally or vertically.
[Fixed] or [Device] are selectable to set the inversion method.
For [Fixed], the following inversion methods are selectable: [None], [Horizontal], and [Vertical].

For [Device], the inversion method depends on the device value as shown below.

Device value Rotation angle

0 [None]

1 [90 degrees to the right]

2 [180 degrees]

3 [90 degrees to the left]

4 or more [None]

[None] [90 degrees
 to the right] [180 degrees] [90 degrees

 to the left]

Input image

Device value Inversion method

0 [None]

1 [Horizontal]

2 [Vertical]

3 or more [None]

[None] [Vertical][Horizontal]
RGB image
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(4) Filling blank space
You can select whether to fill blank space with a specified color when an input image is smaller than a video/RGB display 
object.
For filling blank space, 65536 colors are selectable.
When the blank space is not filled, other figures and objects under the blank space are displayed.

(5) Clip display
You can specify the clip origin to cut out a part of an input image to be displayed.
Specify the clip origin in units of 4 dots by using the X and Y coordinates of the input image as the reference.
The following shows the setting ranges for the X and Y coordinates of the clip origin.

• X coordinate: -1280 dots to 1280 dots
• Y coordinate: -1024 dots to 1024 dots

The clip origin is in the upper left corner of the clip area. The GOT displays the clip area as the same size as the video/
RGB display object.
Portions of the clip area that extend off the input image are displayed as blank space.

[Fixed] and [Device] are selectable to specify the clip origin.
When selecting [Device], set the first device. Two consecutive devices (signed 16-bit binary), the first device and the 
subsequent device, are automatically assigned to the X and Y coordinates of the clip origin.

• First device: X coordinate
• Second device: Y coordinate

The blank space 
is filled.

The blank space 
is not filled.

RGB image

Input image

Clip area 
(the same size as the object)

Clip origin
X , Y = (-20 ， -20)

Clip display

Input image origin
X, Y = (0, 0)

Blank space
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■9 Display mode
The video/RGB display object is displayed in front of or behind all other figures and objects on the same screen, 
regardless of the layers and object display order of the screen.
When the video/RGB display object is displayed behind all other figures and objects, the transparent method and color 
are settable with [Display Mode] in the [Video/RGB Input Common] dialog.
For the setting procedure, refer to the following.

➟10.6.5 [Video/RGB Input] dialog

(1) Display in the foreground
The video/RGB display object is displayed in front of all other figures and objects on the same screen.
Overlapping figures and objects are hidden behind the video/RGB display object.

(2) Display on the specified color area (behind all other figures and objects)
The video/RGB display object is displayed behind all other figures and objects on the same screen.
When a figure or object overlaps the video/RGB display object, the video/RGB display object passes through the 
specified color.

(3) Display on the area of other colors (behind all other figures and objects)
The video/RGB display object is displayed behind all other figures and objects on the same screen.
When a figure or object overlaps the video/RBB display object, the video/RGB display object does not pass through the 
specified color.
(However, the video/RBG display object passes through colors other than the specified one.)

Front layer

Back layer

The video/RGB display object
The video/RGB display object is 
displayed in front of all other figures 
and objects on the same screen.

Front layer

Back layer

The video/RGB display object

Figure filled with the specified color

The video/RGB display object passes 
through the specified color only.

Front layer

Back layer

The video/RGB display object

Figure filled with the specified color

The video/RGB display object does not 
pass through the specified color.
(The object passes through colors other
 than the specified one.)
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8.27.2 How to use the video/RGB display object

■1 System configuration
The following shows the system configuration to use the video/RGB display object.

*1 The cable length depends on the specifications of the RGB output device used.
*2 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputer, MODBUS/Fieldbus Products, Peripherals) for GT Works3 
Version1

■2 Setting procedure
Step 1 Connect the GOT and the RGB output device.

➟■1 System configuration
Step 2 Select [Common] → [Peripheral Setting] → [Video/RGB Input] from the menu to display the [Video/RGB 

Input] dialog.

➟10.6.5 [Video/RGB Input] dialog
Step 3 In the [Video/RGB Input] dialog, set the items as shown below and click the [OK] button.

• [Destination I/F]: [Extend I/F(1st)]
• [Use Video/RGB Input]: Selected
• [Unit Type Name]:[GT27-R2 (RGB Screen only)]
• [Display Mode]: Display mode for a video/RGB display object

Step 4 Display a screen to place a video/RGB display object.

➟2.5.2 Opening and closing screens
Step 5 Select [Object] → [Video/RGB Display] from the menu, and place the object on the screen editor.
Step 6 Double-click the object to configure the setting.

➟8.27.4 [Video/RGB Display] dialog
Step 7 Write package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to 
thefollowing.

➟4. COMMUNICATING WITH GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Signal type RGB output device Connection 
cable*1

GOT Number of 
connectable RGB 

devicesOption GOT model

Analog RGB

For the connectable RGB output devices, refer to 
the following Technical News.
➟List of Valid Devices Applicable for GOT2000 

Series and GOT SIMPLE Series (for 
Overseas) (GOT-A-0160)

GT15-
C50VG(5m)
or Preparing 
connection 
cables by each 
user*2

GT27-R2 GT27 Two RGB output 
devices for one GOT

RGB output device 
(such as a personal computer)

GOT

Connection cable
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■3 Operation on the GOT
To perform operation by touching the video/RGB display object on the GOT, set [Touch Mode] in the [Video/RGB Setting] 
tab in the [Video/RGB Display] dialog.
For the details of the setting method, refer to the following.

➟8.27.4 [Video/RGB Display] dialog

(1) Magnification switching (Loop)
Enlarge or reduce an input image by one magnification factor according to the setting of [Change Direction] with a touch 
of the video/RGB display object.
The display magnification is wrapped around at its maximum or minimum factor.
Example) When selecting [Smaller ratio] for [Change Direction]

(2) Magnification switching (Reciprocation)
Enlarge or reduce an input image by one magnification factor with a touch of the video/RGB display object.
The display magnification is switched in the opposite direction at its maximum or minimum factor.

(3) Gesture operation
Reduce or enlarge an input image or reposition the clip origin with the object gesture function.
To reduce or enlarge the input image, pinch in or pinch out the image.
The image is reduced or enlarged by moving fingers toward or away from each other.

400％ 100% 25％

・ ・ ・

200％ 87.5%

400％ 100% 25％

・ ・ ・
200％ 87.5%

・ ・ ・

Reduce Enlarge
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To reposition the clip origin, slide the origin.
The clip area is scrolled by the slide operation.

For the details of the object gesture, refer to the following.
➟11.13 Operating Objects by the Gesture (Object Gesture Function)

(4) Remote personal computer operation function (Serial)
Remotely operate the mouse pointer of the personal computer with the remote personal computer operation function 
(Serial).
For the details of the remote personal computer operation function (Serial), refer to the following.

➟10.4 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation (Serial))

Scroll

Input image
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8.27.3 Precautions for a video/RGB display object

■1 Precautions for drawing
(1) Functions that cannot be used together

The following functions cannot be used together with the video/RGB display object.
• Video display function
• RGB display function
• Video output function
• Multimedia function

(2) Placing a video/RGB display object on a window screen
Make sure to place a video/RGB display object 4 dots or more away from the edges of a window screen.
The GOT can only display the video/RGB display object with the X and Y coordinates in units of 4 dots.
If the window screen is moved or switched, the video/RGB display object may not be displayed with the X and Y 
coordinates in units of 4 dots.
In such a case, the X and Y coordinates of the object are automatically corrected toward the input image origin.
If the video/RGB display object is too close to the edges of the window screen, the displayed input image may overlap 
the window frame depending on the position of the window screen.

(3) Object stacking order when a video/RGB display object is placed
The video/RGB display object is not targeted for the object stacking order adjustment setting.
The GOT always displays the video/RGB display object in front of or behind all other figures and objects on the same 
screen.

(4) Placing an input object on a video/RGB display object
When placing an object requiring touch operation, such as a touch switch or numerical input, on the video/RGB display 
object, select [Disabled] for [Touch Mode] of the video/RGB display object.
Otherwise, the touch operation of the overlapping object is not performed properly.

(5) Number of video/RGB display objects that can be placed when the remote personal computer 
operation function (Serial) is used
When using the remote personal computer operation function (Serial), do not place multiple video/RGB display objects 
on the same screen.
Otherwise, the touch operation of the video/RGB display object may not be performed properly.

(6) Clip origin setting
If an input image is outside the clip area according to the specified clip origin, the image is not displayed within the video/
RGB display object.
Set the clip origin while making sure that the image is within the clip area.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Input image
(480×272)

Clip origin 
X, Y = (500, 100)

Input image
origin 

X, Y = (0, 0)

Clip area

The input image is not displayed 
because it is outside the clip area.
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■2 Precautions for use
(1) Displaying a window screen on a video/RGB display object

Do not display multiple window screens on a video/RGB display object.
Otherwise, the following may occur.

• Window screens, figures, and objects are not displayed in a correct order.
• The video/RGB display object is not displayed.
• A system alarm occurs.

(2) Restrictions on the video/RGB display object in the window screen
When a window screen contains a video/RGB display object, the input image of the object may not be displayed properly 
if the window screen lies off the GOT screen.
Make sure that such a window screen does not lie off the GOT screen.
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8.27.4 [Video/RGB Display] dialog

Displaying video images will be supported soon.
The video/RGB display object displays an RGB image on the GOT screen.

Step 1 Select [Object] → [Video/RGB Display] from the menu.
Step 2 Click the position to place a video/RGB display object.
Step 3 Adjust the size of the object.
Step 4 Double-click the object to display the setting dialog.

➟■1 [Video/RGB Setting] tab
■2 [Extended] tab
■3 [Trigger] tab

■1 [Video/RGB Setting] tab

1) [CH No.]
Select the channel number of an RGB output device.
The following shows the items to be selected.

• [Fixed]
Select the channel number.
The selectable channel numbers are [RGB CH1] and [RGB CH2].

• [Device]
Specify the channel number with a device value.
Select this item, and then set a device.

2) [Display Magnification]
Select the display magnification of an input image.
For the details of the display magnification, refer to the following.

➟8.27.1 ■8 (1) Display magnification
The following shows the items to be selected.

• [Fixed]
Select the display magnification.
The following shows the items to be selected.
[25] %
[37.5] %
[50] %
[62.5] %

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)

5)
6)
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[75] %
[87.5] %
[100] %
[200] %
[400] %

• [Device]
Specify the display magnification with a device value.
Select this item, and then set a device.

• [Auto-resizing]
Automatically adjusts the display magnification according to the size of a video/RGB display object.

3) [Rotation Angle]
Select the rotation angle of an input image.
For the details of the rotation angle, refer to the following.

➟8.27.1 ■8 (2) Rotation angle
The following shows the items to be selected.

• [Fixed]
Select the rotation angle.
The following shows the items to be selected.
[None]
[90 degrees to the right]
[180 degrees]
[90 degrees to the left]

• [Device]
Specify the rotation angle with a device value.
Select this item, and then set a device.

4) [Inversion]
Select the inversion method of an input image.
For the details of the inversion method, refer to the following.

➟8.27.1 ■8 (3) Inversion
The following shows the items to be selected.

• [Fixed]
Select the inversion method.
The following shows the items to be selected.
[None]
[Horizontal]
[Vertical]

• [Device]
Specify the inversion method with a device value.
Select this item, and then set a device.

5) [Touch Mode]
Select the operation performed when a video/RGB display object is touched.
For the details of the touch mode, refer to the following.

➟8.27.2 ■3 Operation on the GOT
The following shows the items to be selected.

• [Disabled]
Disables the touch operation.

• [Gesture Operation (Scaling/Scrolling)]
Enlarges or reduces an input image or repositions the clip origin by using the gesture operation.

• [Magnification Switching (Loop)]
Enlarges or reduces an input image according to the setting of [Change Direction].
The display magnification is wrapped around at its maximum or minimum factor.

• [Magnification Switching (Reciprocation)]
Enlarges or reduces an input image.
The display magnification is switched in the opposite direction at its maximum or minimum factor.

• [PC Remote Operation (Serial)]
Remotely operates the mouse pointer of the personal computer by using the remote personal computer 
operation function (Serial).
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6) [Change Direction]
This item appears when [Touch Mode] is set to [Magnification Switching (Loop)].
Select the direction of the display magnification switching.
The following shows the items to be selected.

• [Larger ratio]
• [Smaller ratio]

■2 [Extended] tab

1) [Security Level]
Set the security level when using the security function.
The setting range is [1] to [15].
Set the level to [0] when the security function is not used.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Blank Space Fill Color]

Fills the blank space of a video/RGB display object.
Select this item, and then set a color to fill the space.
For the details of filling blank space, refer to the following.

➟8.27.1 ■8 (4) Filling blank space
3) [Clip Origin]

Set the clip origin for the clip display.
For the details of the clip display, refer to the following.

➟8.27.1 ■8 (5) Clip display
The following shows selectable items.

• [Fixed]
Specify the clip origin within given ranges.
Select this item, and then set [X Position] and [Y Position].
The following shows the setting ranges.
[X Position]: [-1280] dots to [1280] dots
[Y Position]: [-1024] dots to [1024] dots

• [Device]
Specify the clip origin with a device value.
Select this item, and then set the first device. Two consecutive devices (signed 16-bit binary), the first device 
and the subsequent device, are automatically assigned to the X and Y coordinates of the clip origin.
First device: X coordinate
Second device: Y coordinate

4) [Layer]
Switches layers to be placed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4) 5)
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The following shows the items to be selected.
• [Front]
• [Back]

This setting is valid only for filling blank space.
For the details of filling blank space, refer to the following.

➟8.27.1 ■8 (4) Filling blank space
5) [Category]

Select the category to assign the object.
➟11.7 Managing figures and objects by category

■3 [Trigger] tab

1) [Control Displaying/Hiding]
Set the control device to display or hide the object.
Select the ON/OFF status of the set device to display the object.
The following shows the items to be selected.

• [ON Display]
• [OFF Display]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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8.27.5 Relevant settings

Set the relevant settings other than the specific settings for the video/RGB display object as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
For the details of the devices, refer to the following.

➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the input status of the RGB signal for CH1 is recognized GS252.b15

Checking if the input status of the RGB signal for CH2 is recognized
(when an RGB input unit, GT27-R2 or GT27-R2-Z, is used) GS252.b14

Checking the RGB signal input status of CH1 GS1030

Checking the RGB signal input status of CH2 GS1035

Checking the RGB signal horizontal resolution for CH1 GS1031

Checking the RGB signal horizontal resolution for CH2 GS1036

Checking the RGB signal vertical resolution for CH1 GS1032

Checking the RGB signal vertical resolution for CH2 GS1037

Checking the RGB signal refresh rate for CH1 GS1033

Checking the RGB signal refresh rate for CH2 GS1038
8. OBJECT FUNCTION
8.27 Placing a Video/RGB Display Object

8 - 737



8.28 Placing a Script Parts Object

A script parts object is placed to create a script.
When the GOT displays the screen on which a script parts object is placed, if the trigger condition for the created script 
is satisfied, the script runs.
The following object manipulations are supported.

• Copying to another screen
• Grouping
• Registering to the library
• Adding to a template

A script parts object is visible only on the screen editor of GT Designer3.
The object is invisible on the GOT screen.
For information on how to place a script parts object and configure its settings, refer to the following.

➟9.9.3 ■1 (2) Procedure for setting a script part
For the types of scripts, refer to the following.

➟9.8 Controlling Operations with Scripts ([Script])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.29 Placing Another Screen on a Screen

Calling other base screens and window screens (called screen) on a basic screen, this function displays them as a single 
screen.
When the same objects are used on multiple screens, memory space can be saved.

• When using no set over screen
Four touch switches need to be set.
(two on base screen 1, two on base screen 2)

• When using a set over screen
Only two touch switches need to be set.
(two on a called screen)
Because production status screen 1 and 2 display the touch switches on the called screen, no touch switch is 
required to be placed on production status screen 1 and 2.

Application examples
• Displaying multiple called screens on one basic screen

• Placing hierarchically and displaying

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

RUN STOPRUN STOP

Base screen 1 Base screen 2

Production status 
screen 1

Production status 
screen 2

RUN STOPRUN STOP

Basic screen
(Base screen 1)

Basic screen
(Base screen 2)

RUN STOP

Called screen
(B-10: Base screen 10)

Production status 
screen 1

Production status 
screen 2

Create a screen for placing touch switches 
and call it from each basic screen.

Called screen
(B2: Base screen 2)

Basic screen
(Base screen 1)

A D
CDEB

Called screen
(B3: Base screen 3)

FE
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Basic screen
(Base screen 1)

Called screen
(B-10: Base screen 10)

1st 2nd 3rd

Called screen
(B-6: Base screen 6)

Called screen
(W-1: Window screen 1)

Called screen
(W-3: Window screen 3)

348B
A1254 348B

A1254

348B
A1254

Production status screen 1

Production status screen 2

Basic screen
(Base screen 2)

348B
A1254
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8.29.1 Specifications of the set overlay screen

The following shows the specifications of the set overly screen.

■1 Type of a screen that can be used as the basic screen
The following screens can be used as the basic screen.

• Base screen
• Window screen (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• Mobile screen (GT27, GT25, GT SoftGOT2000, and GS25)

For calling a mobile screen, refer to the following.
➟10.19.2 ■2 Usable functions

■2 Types of screens that can be used as called screens
The following screens can be used as called screens.

• Base screen
• Window screen
• Mobile screen (GT27, GT25, GT SoftGOT2000, and GS25)

For calling a mobile screen, refer to the following.
➟10.19.2 ■2 Usable functions

The trigger actions and screen scripts set for the called screens are executed. (Not available to GT21 and GS21)

■3 Number of set overlay screens that can be placed
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Up to 2047 set overlay screen objects can be placed.
• For GT21 and GS21

Up to 5 set overlay screen objects can be placed.

■4 Hierarchy of called screens
(1) Number of layers in the hierarchy

Set overlay screens can be also placed on screens used as called screens.
The type of the basic screen determines the maximum number of layers of displayable called screens.

(2) Relation between security levels of called screens and the display of the layers in the hierarchy
The security set for each called screen is valid.
The following shows the specifications when security is set for each called screen.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
If the password entered on a basic screen is set for a security level lower than that of a called screen, the called 
screen is not displayed.
Screens called in nested structures from the screens that cannot be displayed are not displayed.
If a called screen is not displayed, the trigger action and screen script set for the called screen are not executed.

• For GT21 and GS21
Called screens are displayed regardless of the security level entered on the basic screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Model Screen type Maximum number of 
layers

GT27
GT25
GT SoftGOT2000
GS25

Base screen
Window screen

16

Mobile screen 1

GT23

Base screen
Window screen

16

Mobile screen -

GT21
GS21

Base screen
Window screen

4

Mobile screen -
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Example) Called screens that can be displayed with a password in security level 2 (for GT27)

(3) Display order applied when multiple screens are called
When multiple set overlay screens are placed on one screen, the display order of the called screens is determined 
according to the order of setting with GT Designer3 and the layer in the hierarchy at which the called screens are set.
Called screens are displayed on previously displayed screens. Hence screens placed later in the display order are 
displayed in front.
The following shows the specifications of the display order.

• When multiple called screens are set on a basic screen, the screens are displayed in order of setting with GT 
Designer3.

• When called screens are placed hierarchically, the screens are displayed in order of layer in the hierarchy from the 
shallowest depth.

• When multiple called screens are set on a basic screen and a hierarchy is established, the screens placed 
hierarchically are displayed first.

Example) When multiple called screens are set on one screen and there are ones placed hierarchically among the called 
screens (1) to 11): Display order)

Basic screen
Security
level 0

Called screen 1
Security
level 1

Called screen 2
Security
level 3

Called screen 4
Security
level 2

Called screen 5
Security
level 4

Called screen 6
Security
level 1

Called screen 7
Security
level 2

Called screen 8
Security
level 1

Called screen 9
Security
level 2

Called screen 10
Security
level 3

Called screen 3
Security
level 1

Screens not displayed

Hierarchy 
of called 
screens

1st

3rd

2nd

6) 9)2)

11)4)

7)5) 8) 10)3)

B 1254A 1254
348D348C

Order in which called screens are set with GT Designer3

1) Basic screen
30 June, 2013
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(1) Security function, trigger action function, and script function set for each called screen
The security function, trigger action function, and script function set for each called screen are executed in 
the display order of the called screens.

(2) How to check the hierarchy and order in which called screens are set
The hierarchy can be checked in the screen view tree.

➟2.2.4 Work tree
The order in which called screens are set can be checked in the data view.
For how to use the data view, refer to the following.

➟6.5.2 Selecting figures and objects on the screen editor

8.29.2 How to use the set overlay screen

The following shows how to use the set overly screen.

■1 Placing the set overlay screen
The following shows how to place the set overlay screen.

Step 1 Select [Object] → [Display Overlay Screen] from the menu.
Step 2 The [Display Overlay Screen] dialog appears.

Select a called screen with any one of the following methods and click the [OK] button.
• Select a called screen from the window selection tree.
• Click the [Screen No.] button to display the [Number Specification] dialog, and specify the screen 

number that has assigned to the called screen.
• Click the [Image] button to display the [Screen Image List] dialog, and select a called screen from the 

screen images.

Step 3 On the screen editor, place the set over lay screen.
Click the position where you place the called screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Set Overlay Screen] dialog

[Screen Image List] dialog

[Number Specification] dialog
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(1) Editing called screens
Double-click the set overlay screen that has been placed on the screen editor to open and edit the called 
screen.

(2) Simpler way of setting
Called screens can be placed by dragging them from the screen view tree.

■2 Checking set overlay screen settings
Set overlay screen settings can be checked in the screen view tree.
For the details of the screen view tree, refer to the following.

➟2.2.4 Work tree

8.29.3 Precautions for a set overlay screen object

This section explains the precautions for set overlay screens.

■1 Editing called screens
Called screens cannot be edited with the set overlay screens (object).
Open the called screens and edit them.
When called screens are edited, the edits are reflected to all the set overlay screens.

■2 Editing figures overlapping with set overlay screens
When figures are placed on a basic screen on the back of set overlay screens (object), the figures cannot be edited.
When selecting and editing figures on a basic screen, click the [Edit] → [Object of Selection] from the menu to deselect 
[Display Overlay Screen].

■3 Figures and objects placed in the temporary area
When figures and objects are placed in the temporary area for called screens, the figures are displayed but the objects 
are not displayed with the GOT.

■4 Display of called screens viewed when figures and objects are overlapping
When called screens and figures/objects overlap in the same layer, they are displayed with the GOT as follows.
For the details of superimposition, refer to the following.

➟6.5.5 ■3 Superimposition

The called screen 
is displayed.Click where the 

screen is called.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Base screen 4 Base screen 5

Base screen 1

Base screen 4 Base screen 5

Base screen 1
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(1) Figure
The shape of the called screen is displayed in front.

When paints are set for figures on the basic screen and the figures overlap with the shapes of called screens, the colors 
of the figures may not be displayed correctly.
When the color of a figure is not displayed correctly, set the color fill of the figure with the setting dialog for the figure.

(2) Screen Background
The background color of the called screen is displayed in front.
When the area of the background color overlaps with figures, the figures are not displayed.

When no background color is set or [No pattern] is set for [Pattern] of the background color, the called screen is displayed 
in the background color of the basic screen.

(3) Object
Among the objects on basic screens and called screens, ones on which values change are displayed in front.

Called screenBasic screen
Screen display

+

Screen display

+

Called screenBasic screen

Screen display

+

Called screenBasic screen

Color fill with paint

Screen display

+

Called screenBasic screen

Screen display

+

Called screenBasic screen
No background color is 
set or [No pattern] is 
set for [Pattern].

12345

Screen display

+

Called screenBasic screen

000001
12345

000001
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(4) Touch switch
Initially, touch switches placed later in the display order are displayed in front.
Subsequently, those with display conditions changed are displayed in front.

■5 Displaying the objects of the types for which only one object can be set on one screen
Do not place on both a basic screen and called screen the objects of the types for which only one object can be set on 
one screen.
When they are placed, they are displayed but the functionality is limited and they do not work correctly.

8.29.4 [Set Overlay Screen] dialog

The set overlay screen is an object that calls other base screens and window screens (called screen) on a basic screen 
and display them as a single screen.

Step 1 Select [Object] → [Display Overlay Screen] from the menu.
The [Display Overlay Screen] dialog appears.

1) [Screen Selection]
Select the screen used as a called screen from the tree.
Screens being edited cannot be selected.

2) [Screen No.] button
When specifying a called screen with a screen number, click this button.
Displays the [Number Specification] dialog.

Screen display
Called screenBasic screen

Item Description

[Screen Type]

Select the type of the screen used as a called screen.
The following shows the items to be selected.
When the basic screen is a mobile screen, the selection is fixed to [Mobile].
• [Base Screen]
• [Window Screen]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3)
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3) [Image] button
When selecting a called screen from the screen preview list, click this button.
Displays the [Screen Image List] dialog.

4) [OK] button
After selecting the screen used as a called screen, click this button.
Close the [Set Overlay Screen] dialog.
After clicking this button, click where the called screen should be displayed.

[Screen No.]
Set the number that has been assigned to the screen used as a called screen.
The setting range is [0] to [32767].
Screen numbers cannot be set if the corresponding screens are non-existent.

Item Description

[Screen Type]

Select the type of the screen used as a called screen.
The following shows the items to be selected.
When the basic screen is a mobile screen, the selection is fixed to [Mobile].
• [Base Screen]
• [Window Screen]
After selecting the type, select the screen used as a called screen.

[Jump] button
Enter a screen number and click this button to select the corresponding screen.
The setting range is [0] to [32767].
Screen numbers cannot be set if the corresponding screens are non-existent.

Item Description
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8.29.5 Relevant settings

Set the relevant settings other than the specific settings for the set overlay screen as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT environmental settings (Screen switching/window setting)
Select [Common] → [GOT Environmental Setting] → [Screen Switching/Windows] from the menu to display the 
[Environmental Setting] dialog.

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other
[Check for overlapping objects in the GOT]
(Not available to GT21 and GS21)

Adjusting the stacking order of the objects on the GOT to that on GT Designer3

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT 
Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Setting the position of a called screen in front of or behind the basic screen
Regardless of this setting, if the basic screen is a mobile screen, a called screen is always 
positioned in front of the basic screen.

[Overlay Screen Positioning]

Setting whether to disable the background color of a called screen
Regardless of this setting, if the basic screen is a mobile screen, the background color of 
a called screen is always enabled.

[Disable background colors of overlay screen when setting 
an overlay screen]
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8.30 Specifying the Display Position of a Window Screen

Set the position of a window screen to be displayed on a base screen or mobile screen.

(1) Operation on the GOT
An overlap window can be moved on the screen of the GOT.
A superimpose window cannot be moved on the screen of the GOT.

(2) Controlling the display position of the overlap window with devices
The display position of the overlap window can be controlled with the device value.

8.30.1 Specifications of the window position

The following shows the specifications of the window position.

■1 The type of the screen for which the window position can be set
The window position setting is available for a window screen to be displayed on a base screen or mobile screen.

■2 The type of the screen for which the display position can be set
The following shows the type of windows for which the display position can be set.
• Overlap window
• Superimpose window
• Key window (Not applicable to mobile screens)

8.30.2 How to use the window position

The following shows how to use the window position.

■1 Setting the window position
The following shows the procedure for setting a window position.

Step 1 Select [Object] → [Window position] from the menu and select the window whose position is to be set.
The following shows the items to be selected.
Overlap windows 3 to 5 and key windows are not applicable to mobile screens.
• [Overlap Window1]
• [Overlap Window2]
• [Overlap Window3]
• [Overlap Window4]
• [Overlap Window5]
• [Superimpose 1]
• [Superimpose 2]
• [Key Window]

Step 2 Click the position where you display the window.
A mark indicating the window position is placed.

To display a key window at the position where a window position object is placed, configure one of the following settings.
• In the [Environmental Setting] window, select [Not move] for [Key Window Position Correction] on the [Advanced 

Setting] tab.
➟5.2.4 ■4 (2) [Advanced Setting] tab

• In the [Screen Property] dialog for a base screen, select [Not move] for [Key Window Position Correction] on the [Key 
Window Advanced Setting] tab.

➟2.7.1 ■3 [Key Window Advanced Setting] tab
A key window appears near an input object by default.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Displaying the preview on the screen editor
The preview of the window screen placed as the window position can be displayed on the screen editor.
For details, refer to the following.

➟2.9.2 Displaying the preview of a window screen on the screen editor

8.30.3 Precautions for a window position object

This section explains the precautions for the window position.

■1 When using a set overlay screen
The setting of the window position is valid when the screen is opened as the basic screen.
When the screen for which the window position is set is opened as a called screen, the setting of the window position is 
invalid.
For the details of the set overlay screen function, refer to the following.

➟8.29 Placing Another Screen on a Screen

■2 When a window screen extends off the screen
At setting of the window position, the size of the window screen is not considered.
When a window screen extends off the screen on which the window screen is placed, depending on the screen type, the 
window screen is displayed differently.

(1) Overlap window
The behavior depends on the setting of [Display windows beyond the screen area] in the [Environmental Setting] window 
([Screen Switching/Window]).
For details, refer to the following.

➟5.2.1 ■5 [Screen Switching/Window]

(2) Superimpose window
The window screen does not move, and the part extending off the screen on which the window screen is placed is not 
displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen on which the 
window screen is 
placed

Window screen

Action switch
Action
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8.31 Placing an Object to Display the Input Information

This function displays the information about the input when numerical values or texts are input to an object using key 
windows.
For the details of the key window, refer to the following.

➟5.2.4 Setting key windows ([Key Window])

8.31.1 Specifications of key window objects

The following shows the specifications of key window objects.

■1 Key window object types
The following show the information that can be displayed on the key window objects.

• Input value area: Displays the numerical value or text which is being input to the object.
• Input range area: Displays the maximum and minimum values which can be input to the object.
• Input maximum range area: Displays the maximum value which can be input to the object.
• Input minimum range area: Displays the minimum value which can be input to the object.
• Previous value area: Displays a numerical value or text previously input to the object.

■2 Types of the screen where the key window object can be placed
The following shows the types of the screen where the key window object can be placed.

• Base screen
• Window screen

■3 Number of placeable key window objects
You cannot place each key window object more than once on a screen.
You cannot also place two or more objects in the same type on a screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.31.2 How to use key window objects

The following shows how to use key window objects.

■1 Placing the key window object
The following shows how to place the key window object.

Step 1 Select [Object] → [Key Window Object] from the menu, and then select a key window object to be placed.
The following shows the items to be selected.

• [Input Value Area Setting]
• [Input Range Area Setting]
• [Input Maximum Value Area Setting]
• [Input Minimum Value Area Setting]
• [Previous Value Area Setting]

Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Adjust the frame size of the object.
Step 4 Double-click the placed object to display the [Input Value Area Setting] dialog.

➟8.31.4 [Input Value Area Setting] dialog
8.31.5 [Input Range Area Setting] dialog
8.31.6 [Input Maximum Value Area Setting] dialog
8.31.7 [Input Minimum Value Area Setting] dialog
8.31.8 [Previous Value Area Setting] dialog

Step 5 Click the [OK] button to complete the object settings.

8.31.3 Precautions for a key window object

The following shows the precautions for key window objects.

■1 Operations for displaying the key window object
The following shows operations that display the key window object except inputting numerical values or texts to the 
object.

• The security level is changed.
• The language is switched.
• The system language is switched.
• The station number is switched.
• The character code is changed by the Character Code Control (GS456).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.31.4 [Input Value Area Setting] dialog

The key window object is an object that displays the information about the input when numerical values or texts are input 
to an object using key windows.
The numerical value or text which is being input to the object is displayed in the input value area.

Step 1 Select [Object] → [Key Window Object] → [Input Value Area Setting] from the menu.
Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Double-click the placed object to display the [Input Value Area Setting] dialog.

1) [Display Format]
Select the display format.
This setting only determines the setting range of [Digits].
The key window operates on the GOT according to the format of the input object.
The following shows the items to be selected.

• [DEC]
• [HEX]
• [Text]

To create a key window for inputting decimal values, select [DEC].
To create a key window for inputting hexadecimal values, select [HEX].
To create a key window for inputting octal values, select [DEC] or [HEX].
To create a key window for inputting binary values, select [DEC].
To create a key window for inputting characters, select [Text].

2) [Detail]

Item Description

[Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Size]
Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications

[Digits]

Set the digits to be displayed.
If [DEC] is selected for [Type], the setting range is [1] to [33] digit(s).
If [HEX] is selected for [Type], the setting range is [1] to [16] digit(s).
If [Text] is selected for [Type], the setting range is [1] to [100] digit(s).

[Text Color] Set the text color.

[Background Color] Set the color for the object.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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8.31.5 [Input Range Area Setting] dialog

The key window object is an object that displays the information about the input when numerical values or texts are input 
to an object using key windows.
The maximum and minimum values which can be input are displayed in the input range area.

Step 1 Select [Object] → [Key Window Object] → [Input Range Area Setting] from the menu.
Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Double-click the placed object to display the [Input Range Area Setting] dialog.

1) [Display Format]
Select the display format.
This setting only determines the setting range of [Digits].
The key window operates on the GOT according to the format of the input object.
The following shows the items to be selected.

• [DEC]
• [HEX]

To create a key window for inputting decimal values, select [DEC].
To create a key window for inputting hexadecimal values, select [HEX].
To create a key window for inputting octal values, select [DEC] or [HEX].
To create a key window for inputting binary values, select [DEX].

2) [Detail]

Item Description

[Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Size]
Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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[Digits]

Set the digits to be displayed.
The setting range is [15] to [79] digits.
When the device is set with a range expression and the device value exceeds the set number of digits, ? 
may be displayed.
Set the number of digits in consideration of the device value referring to the following.
Example 1) D100 <= INPUT <= D200

Example 2) D100 < INPUT

[Text Color] Set the text color.

[Background Color] Set the color for the object.

Item Description

1 2 1 5Required 
number 
of digits

Requires 25 digits.
Input range

* For 16-bit signed decimal numbers

13 digits6 digits 6 digits+ +

INPUTD 1 0 0  <= D 2 0 0
Device value 
(-32767 to 
       32767)*

Device value
(-32767 to 
       32767)*

1 2 1
<=

1 1 5Required 
number 
of digits

Requires 14 digits.
Input range

* For 16-bit signed decimal numbers

8 digits6 digits +

INPUTD 1 0 0  <
Device value 
(-32767 to
       32767)*

1
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8.31.6 [Input Maximum Value Area Setting] dialog

The key window object is an object that displays the information about the input when numerical values or texts are input 
to an object using key windows.
The maximum value which can be input is displayed in the input maximum range area.

Step 1 Select [Object] → [Key Window Object] → [Input Maximum Value Area Setting] from the menu.
Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Double-click the placed object to display the [Input Maximum Value Area Setting] dialog.

1) [Display Format]
Select the display format.
This setting only determines the setting range of [Digits].
The key window operates on the GOT according to the format of the input object.
The following shows the items to be selected.

• [DEC]
• [HEX]

To create a key window for inputting decimal values, select [DEC].
To create a key window for inputting hexadecimal values, select [HEX].
To create a key window for inputting octal values, select [DEC] or [HEX].
To create a key window for inputting binary values, select [DEX].

2) [Detail]

Item Description

[Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Size]
Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications

[Digits]

Set the digits to be displayed.
The setting range depends on the selection for [Type].
• [DEC] is selected for [Type]: [1] to [33] digit(s)
• [HEX] is selected for [Type]: [1] to [16] digit(s)
When the number of digits exceeds the set value, ? is displayed.

[Text Color] Set the text color.

[Background Color] Set the color for the object.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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8.31.7 [Input Minimum Value Area Setting] dialog

The key window object is an object that displays the information about the input when numerical values or texts are input 
to an object using key windows.
The minimum value which can be input is displayed in the input minimum range area.

Step 1 Select [Object] → [Key Window Object] → [Input Minimum Value Area Setting] from the menu.
Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Double-click the placed object to display the [Input Minimum Value Area Setting] dialog.

1) [Display Format]
Select the display format.
This setting only determines the setting range of [Digits].
The key window operates on the GOT according to the format of the input object.
The following shows the items to be selected.

• [DEC]
• [HEX]

To create a key window for inputting decimal values, select [DEC].
To create a key window for inputting hexadecimal values, select [HEX].
To create a key window for inputting octal values, select [DEC] or [HEX].
To create a key window for inputting binary values, select [DEX].

2) [Detail]

Item Description

[Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Size]
Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications

[Digits]

Set the digits to be displayed.
The setting range depends on the selection for [Type].
• [DEC] is selected for [Type]: [1] to [33] digit(s)
• [HEX] is selected for [Type]: [1] to [16] digit(s)
When the number of digits exceeds the set value, ? is displayed.

[Text Color] Set the text color.

[Background Color] Set the color for the object.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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8.31.8 [Previous Value Area Setting] dialog

The key window object is an object that displays the information about the input when numerical values or texts are input 
to an object using key windows.
The numerical value or text that is previously input is displayed in the previous value area.

Step 1 Select [Object] → [Key Window Object] → [Previous Value Area Setting] from the menu.
Step 2 Click the position where you place the object. Placing the object is completed.
Step 3 Double-click the placed object to display the [Previous Value Area Setting] dialog.

1) [Display Format]
Select the display format.
This setting only determines the setting range of [Digits].
The key window operates on the GOT according to the format of the input object.
The following shows the items to be selected.

• [DEC]
• [HEX]
• [Text]

To create a key window for inputting decimal values, select [DEC].
To create a key window for inputting hexadecimal values, select [HEX].
To create a key window for inputting octal values, select [DEC] or [HEX].
To create a key window for inputting binary values, select [DEX].
To create a key window for inputting characters, select [Text].

2) [Detail]

Item Description

[Font]

Select the font of the text.
The following shows the items to be selected.
• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

[Size]
Select a text size.
For the details of the font and size, refer to the following.
➟1.2.5 Font specifications

[Digits]

Set the digits to be displayed.
The setting range depends on the selection for [Type].
• [DEC] is selected for [Type]: [1] to [33] digit(s)
• [HEX] is selected for [Type]: [1] to [16] digit(s)
• [Text] is selected for [Type]: [1] to [100] digit(s)
When the number of digits exceeds the set value, the operation of the GOT differs 
depending on the model.
• GT27, GT25, GT23, GT SoftGOT2000, GS25

? is displayed.
• GT21, GS21

The numbers of the set number of digits from the least digit are displayed.

[Text Color] Set the text color.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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8.31.9 Relevant settings

Set the relevant settings other than the specific settings for the key window object as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

[Background Color] Set the color for the object.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other [Check for overlapping objects in the GOT]

Adjusting the stacking order of the objects on the GOT to that on GT Designer3
Always enabled.

[Adjust object display order in GOT to the one in GT 
Designer3]

GOT Graphic Ver.2

GOT Graphic Ver.1
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8.32 Placing a Print Object on a Report Screen

➟8.32.1 Specifications of the print object
8.32.2 How to use the print object
8.32.3 Precautions for a print object
8.32.4 [Numerical Print] dialog
8.32.5 [Text Print] dialog
8.32.6 [Bit Comment Print] dialog
8.32.7 [Word Comment Print] dialog

The print object is placed on a report screen to print its device value or the comment corresponding to the device.
For the details of the report function, refer to the following.

➟10.11 Outputting the Collected Data as a Report (Report Function)

■1 Numerical print
The numerical print object prints the value stored in a specified device.

■2 Text print
The text print object prints the text stored in specified consecutive devices.

■3 Bit comment print
The bit comment print object prints the comment corresponding to a specified bit device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Production line status

Running 100

50

Product qty

Conveyor is stopped.

Oct. 20, 2013 16:53:24 1

Completed 10

D100 = 100

D100 = 50

D100 = 10

Production line status

Running

Product qty

Conveyor is stopped.

Oct. 20, 2013 16:53:24 1

Completed

100

50

10

Printing the text stored in D200 to D249

Printing the text stored in D250 to D299

Printing the text stored in D300 to D349

Production line status

Running 100

50

Product qty

Conveyor is stopped.

Oct. 20, 2013 16:53:24 1

X10 = OFF: Printing the comment specified when the device is off

X10 = ON: Printing the comment specified when the device is on
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■4 Word comment print
The word comment print object prints the comment corresponding to a specified word device.

8.32.1 Specifications of the print object

■1 Applicable screen
The numerical print, text print, and comment print can be placed on a report screen only.
Up to 260 devices can be monitored on one report screen.
The object devices, collection trigger device, output trigger device, and other devices set for a report screen are included.

■2 Specifications of the numerical print
(1) Maximum number of printable characters

The maximum number of pintable characters depends on the setting of [Format].
• [Signed Decimal] or [Unsigned Decimal]: 21 characters
• [Hexadecimal]: 16 characters
• [Binary]: 32 characters
• [Real]: 33 characters

■3 Specifications of the text print
(1) Maximum number of printable characters

Up to 50 two-byte or 100 one-byte characters are printable.

(2) Supported character code
The following character codes are supported.

• ASCII code
• Unicode
• Shift JIS code
• GB code
• KS code
• Big5 code

(3) Number of monitored devices and number of digits to be printed
The number of monitored devices depends on the device data type, character code, and the number of digits to be 
printed.

Production line status

Running 100

50

Product qty

Conveyor is stopped.

Oct. 20, 2013 16:53:24 1

Completed 10

D200 = 1: Printing comment No.1.

D200 = 10: Printing comment No.10.

D200 = 100: Printing comment No.100.  

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device data type Character code The number of monitored devices

16-bit

ASCII code
Shift JIS code
GB code
KS code
Big5 code

One word device is used for two digits to be printed.

If an odd number of digits is printed, the odd number incremented by 1 is the number of monitored devices.*1

Example) Number of digits to be printed: 3, start device: D1000
Two word devices (D1000 and D1001) starting from D1000 are used.

Unicode
One word device is used for one digit to be printed.
Example) Number of digits to be printed: 3, start device: D1000
Three word devices (D1000 to D1002) starting from D1000 are used.
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*1 The lower- or higher-order bytes of the last device are not monitored.
Whether the lower- or higher-order bytes are not monitored depends on the display order of the string data.

• High to low: Lower-order bytes of the last device
• Low to high: Higher-order bytes of the last device

(4) Order of displaying and storing character strings
You can specify the order of displaying the character strings stored in devices and the order of storing character strings 
in devices.
The following shows the specifications of each character code.

• ASCII code, shift JIS code, GB code, KS code, Big5 code
Specifications differ depending on the data type.
When the data type is 16-bit
Low to high or high to low can be specified.
b8 to b15 of a word device are handled as the higher-order bytes, and b0 to b7 as the lower-order bytes.
When the data type is 8-bit
Only low to high can be specified.
When the start device is GB1000, GB1008 to GB1015 are handled as the higher-order bytes, and GB1000 to 
GB1007 as the lower-order bytes.

Example) Storing 16 bit string data in D1000 to D1001

8-bit

ASCII code
Shift JIS code
GB code
KS code
Big5 code

Eight bit devices are used for one digit to be printed.
Example) Number of digits to be printed: 3, start device: GB1000
Twenty-four consecutive devices (GB1000 to GB1023) starting from GB1000 are used.

Unicode
Sixteen bit devices are used for one digit to be printed.
Example) Number of digits to be printed: 3, start device: GB1000
Forty-eight consecutive devices (GB1000 to GB1047) starting from GB1000 are used.

Device data type Character code The number of monitored devices

Display order and 
storage order Specifications

Low to high

Example) Character code: Shift JIS code

Higher: b8 to b15, lower: b0 to b7

High to low

Example) Character code: Shift JIS code

Higher: b8 to b15, lower: b0 to b7

D1000

D1001

4F 8E

48 95

String:

String data: 0x8E4F 0x9548

High Low

D1000

D1001

8E 4F

95 48

String:

String data: 0x8E4F 0x9548

High Low
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• Unicode
Specifications differ depending on the data type and GOT model.

When the data type is 16-bit
Low to high or high to low can be specified.
b8 to b15 of a word device are handled as the higher-order bytes, and b0 to b7 as the lower-order bytes.

When the data type is 8-bit
Low to high or high to low can be specified.
When the start device is GB1000, GB1032 to GB1063 are handled as the higher-order bytes, and GB1000 to 
GB1031 as the lower-order bytes.

Example) Storing 16 bit string data in D1000 to D1001

■4 Specifications of the comment print
(1) Comment with multiple rows

Only the first row of a comment that involves multiple rows can be printed.

(2) Character property
The character property (character effect, character color, and others) cannot be changed.

(3) Character size
Two-byte characters are placed by 16 dots × 16 dots. One-byte characters are placed by 16 dots × 8 dots.

(4) Maximum number of printable characters
The number of printable characters varies with the setting of [Printer Type] in the [Printer] dialog.

➟10.11.8 [Printer] dialog
[PictBridge], [ESC/P-R] or [PCL5]: 62 two-byte or 124 one-byte characters
[Serial]: 127 two-byte or 255 one-byte characters

Display order and 
storage order

Specifications

GT27, GT25, GT23, GT SoftGOT2000, GS25 GT21, GS21

Low to high

Higher: b8 to b15, lower: b0 to b7 Higher: b8 to b15, lower: b0 to b7

High to low

Higher: b8 to b15, lower: b0 to b7 Higher: b8 to b15, lower: b0 to b7

D1000

D1001

09 4E

F1 83

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

4E 09

83 F1

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

4E 09

83 F1

String:

String data: 0x4E09 0x83F1

High Low

D1000

D1001

09 4E

F1 83

String:

String data: 0x4E09 0x83F1

High Low

(Two-byte 
character)

(One-byte 
character)

8 dots16 dots

16 dots
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8.32.2 How to use the print object

■1 Placing a print object
Comments displayed by a comment print must be registered in advance.

➟5.8 Comment Setting ([Comment])
The following shows how to use the numerical print and comment print.

Step 1 Open the report screen to select [Object] → [Print] from the menu then select either of the following items.
• [Numerical Print]
• [Text Print]
• [Bit Comment Print]
• [Word Comment Print]

Step 2 Click the position to place the selected object.
Step 3 Double-click the object to display the setting dialog.

The setting dialog appears.
➟8.32.4 [Numerical Print] dialog
8.32.5 [Text Print] dialog
8.32.6 [Bit Comment Print] dialog
8.32.7 [Word Comment Print] dialog

Step 4 Click the [OK] button to complete the object settings.

8.32.3 Precautions for a print object

For the precautions for a print object, refer to those for the report function.
➟10.11.4 Precautions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.32.4 [Numerical Print] dialog

Step 1 Select [Object] → [Print] → [Numerical Print] from the menu.
Step 2 Click the position where you place the numerical print. Placing the numerical print is complete.
Step 3 Double-click the numerical print which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Operation] tab

■1 [Device/Style] tab

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [Real(32bit)]
• [Real(64bit)]

3) [Format]
Select the data type at printing.
The following shows the items to be selected.

• [Signed Decimal]
• [Unsigned Decimal]
• [Hexadecimal]
• [Binary]
• [Real]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
4)

6)
7)

5)

8)
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When the device data type is [Signed BIN64], [Unsigned BIN64], or [Real(64bit)], [Binary] cannot be selected.
4) [Digits (Integral)]

Set the integer digits to be printed.
The setting range depends on the setting in [Format].

• [Signed Decimal] or [Unsigned Decimal]: [1] to [21]
• [Hexadecimal]: [1] to [16]
• [Binary] or [Real]: [1] to [32]

5) [Fill with 0]
This item can be set when the right justification is set for numerical values in [Alignment].
Prefixes a numerical value with 0 and adds it.

6) [Digits (Fractional)]
This item can be set when [Real] is set in [Format].
Set the fractional digits to be printed.
The setting range is [0] to [30] digit(s).

7) [Alignment]
Select the direction of the justification for the numerical values to be printed.

8) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Operation] tab

1) [Operation Type]
Select whether to use the data operation function.
The following shows the items to be selected.

• [None]:
Select this item if the data operation is unnecessary.

• [Data Operation]:
Select this item if the data operation is necessary.
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations

Right justification
Left justification

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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2) [Bit Mask]
This item can be set when [Data Operation] is set in [Operation Type].
Set the operation of mask processing.

3) [Bit Shift]
This item can be set when [Data Operation] is set in [Operation Type].
Set the operation of shift processing.

4) [Data Operation]
This item can be set when [Data Operation] is set in [Operation Type].
Set the format of the expression.

• [None]
Select this item not to perform the data operation by using the expression.

• [Data Expression]
Select this item to perform the data operation by using the expression.
Click the [Exp] button to display the [Edit Data Expression] dialog.
Set the expression.

➟6.5.5 ■4 Setting data operations

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern]
Set a pattern value to mask in hexadecimal.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts]
Set the number of bits to be shifted.
The setting range depends on the setting of [Data Type] in the [Device/Style] tab.
8. OBJECT FUNCTION
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8.32.5 [Text Print] dialog

Step 1 Select [Object] → [Print] → [Text Print] from the menu.
Step 2 Click the position to place a text print.
Step 3 Double-click the placed object to display the setting dialog.

1) [Device]
Set the first device to be monitored.

➟6.1.2 How to set devices
The number of monitored devices depends on the setting.
For details, refer to the following.

➟8.32.1 (3) Number of monitored devices and number of digits to be printed
2) [Data Type]

Select the data type of the device to be set.
The following shows the items to be selected.

• [Unsigned BIN16]
• [Unsigned BIN8]

3) [Character Code]
Set the character code applied to text.
The following shows the items to be selected.

• [System Language Link]
• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]

When [System Language Link] is selected, different character code is applied depending on the system language.
• When the system language is English: [ASCII]
• When the system language is not English: [S-JIS]

4) [Print Digits]
Set the number of digits of text printed.
The setting range is [0] to [100].

5) [Alignment]
Select the alignment direction of text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
4)
5)
6)
7)

8)

Right justification
Left justification
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6) [Display in order of High -> Low]
Select this item to display string data stored in devices in order of lower byte to upper byte.
The specifications differ depending on the character code or GOT model.

➟8.32.1 ■3 (4) Order of displaying and storing character strings
7) [KANJI Region]

This item is settable when [Character Code] is set to [Unicode].
Set the KANJI region.
The following shows the items to be selected.

• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

8) [Preview Text]
Set the text to be previewed on the screen editor.
Up to 100 characters can be set.

8.32.6 [Bit Comment Print] dialog

Step 1 Select [Object] → [Print] → [Bit Comment Print] from the menu.
Step 2 Click the position where you place the bit comment print. Placing the bit comment print is completed.
Step 3 Double-click the bit comment print which has been placed to display the setting dialog.

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
2) [Print Digits]

Set the digits of a comment to be printed.
The setting range varies with the setting of [Printer Type] in the [Printer] dialog.

➟10.11.8 [Printer] dialog
• [PictBridge], [ESC/P-R], or [PCL5]: [1] digit to [124] digits
• [Serial]: [1] digit to [255] digits

3) [Comment Group]
Set the comment group number to be used.

• [Fixed]:
Input directly the comment group number to be used.

• [Device]:
Use the comment group of the same number as the device value.
Set the device.

➟6.1.2 How to set devices
4) [Comment No.]

Set the comment No. to be printed while the bit device to be monitored is on or off.
The setting range is [0] to [32767].
If [0] is set, the comment is not printed.
To print the comment No. only while the bit device to be monitored is on, set [0] while it is off.
Click the [Edit] button to display the [Edit Comment] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

5)

4)
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The displayed comments can be edited.

5) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
Up to 100 characters can be set.

8.32.7 [Word Comment Print] dialog

Step 1 Select [Object] → [Print] → [Word Comment Print] from the menu.
Step 2 Click the position where you place the word comment print. Placing the word comment print is completed.
Step 3 Double-click the word comment print which has been placed to display the setting dialog.

➟■1 [Device/Style] tab
■2 [Operation] tab

■1 [Device/Style] tab

1) [Device]
Set the device to be monitored.

➟6.1.2 How to set devices
The comment of the comment No. corresponding to the device value is printed.

2) [Print Digits]
Set the digits of a comment to be printed.

• [Column No.]
Select the column No. of the comment to be edited.

• [Comment]
Edit the comment in the comment group.
If an unregistered comment group number, comment number, or column 
number is specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed 
on the upper right of the comment input field.
• Number of characters:

A character is counted as one character.
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted 
as one row.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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The setting range varies with the setting of [Printer Type] in the [Printer] dialog.
• [PictBridge], [ESC/P-R], or [PCL5]: [1] digit to [124] digits
• [Serial]: [1] digit to [255] digits

3) [Comment Group]
Set the comment group number to be used.

• [Fixed]:
Input directly the comment group number to be used.

• [Device]:
Use the comment group of the same number as the device value.
Set the device.

➟6.1.2 How to set devices
4) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Operation] tab

1) [Operation Type]
Select whether to use the data operation function.
The following shows the items to be selected.

• [None]:
Select this item if the data operation is unnecessary.

• [Data Operation]:
Select this item if the data operation is necessary.
For the settings of the data operation function, refer to the following.

➟6.5.5 ■4 Setting data operations
2) [Bit Mask]

This item can be set when [Data Operation] is set in [Operation Type].
Set the operation of mask processing.

Item Description

[Mask Type]

Select a type of mask processing.
The following shows the items to be selected.
• [AND]: Logical AND
• [OR]: Logical OR
• [XOR]: Exclusive OR

[Mask Pattern] Set a pattern value to mask in hexadecimal.
The setting range is [0000] to [FFFF].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Bit Shift]
This item can be set when [Data Operation] is set in [Operation Type].
Set the operation of shift processing.

4) [Data Operation]
This item can be set when [Data Operation] is set in [Operation Type].
Set the format of the expression.

• [None]
Select this item not to perform the data operation by using the expression.

• [Data Expression]
Select this item to perform the data operation by using the expression.
Click the [Data Expression] button to display the [Edit Data Expression] dialog.
Set the expression.

➟6.5.5 ■4 Setting data operations

8.32.8 Relevant settings

For the settings related to the report function, refer to the following.
➟10.11 Outputting the Collected Data as a Report (Report Function)

Item Description

[Shift Direction]
Select a shifting direction.
• [Left]: Left-shift
• [Right]: Right-shift

[Number of Shifts] Set the number of bits to be shifted.
The setting range is [1] to [15] bit(s).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.33 Placing a Hyperlink on a Mobile Screen

➟8.33.1 Specifications of the hyperlink object
8.33.2 How to use the hyperlink object
8.33.3 Precautions for a hyperlink object
8.33.4 [Hyperlink] dialog

The hyperlink object is placed on a mobile screen to access a website or a file in the GOT public folder, or to make a 
phone call from a GOT Mobile function client.
For the details of the GOT Mobile function, refer to the following.

➟10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)

■1 Application examples
(1) Opening a website

You can access a website by specifying its URL.

(2) Opening a file in the public folder
You can access or download a file in the GOT public folder through a browser.
For the details of the public folder, refer to the following.

➟10.19.2 ■7 Public folder

Example) When accessing a PDF file

(3) Making a phone call
You can call a specified phone number.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Client Client

Website

Client Client

PDF file

Client Client

XXX-XXX-XXXX
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8.33.1 Specifications of the hyperlink object

■1 Maximum number of objects on one screen
The maximum number of hyperlink objects and other objects combined is 1024 on one screen.

■2 Applicable screen
The hyperlink object can be placed only in the mobile screen.

8.33.2 How to use the hyperlink object

■1 Placing a hyperlink object
Place a hyperlink object on the screen editor.

➟6.5.1 Placing figures and objects

■2 Editing a hyperlink object
Edit a hyperlink object placed on the screen editor.

➟6.5.2 Selecting figures and objects on the screen editor
6.5.3 Editing figures and objects

■3 Configuring the hyperlink object setting
Configure the setting for a hyperlink object placed on the screen editor.

• Common setting of objects
➟6.5.5 Common setting for objects

• Hyperlink object setting
➟8.33.4 [Hyperlink] dialog

8.33.3 Precautions for a hyperlink object

■1 Behavior of the hyperlink function dependent on the GOT Mobile function client
(1) When opening a file in the public folder

To open a file in the public folder, the client to be used must have the application that supports the file format.
If the client does not have the applicable application, the file is downloaded to the client.

(2) When making a phone call
To call a specified phone number, the client to be used must have a phone call function.

■2 When hyperlink objects overlap one another
If you touch the overlapping portion between hyperlink objects, the hyperlink object at the front operates only.

■3 When sliding your finger on a hyperlink object
If you slide your finger within the touch area of a hyperlink object, the object operates when you release your finger.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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8.33.4 [Hyperlink] dialog

Step 1 Select [Object] → [Hyperlink] from the menu.
Step 2 Click the position to place a hyperlink object.
Step 3 Double-click the placed object to display the setting dialog.

➟■1 [Action/Style] tab
■2 [Text] tab
■3 [Extended] tab
■4 [Trigger] tab

■1 [Action/Style] tab

1) [Hyperlink Function]
The setting items differ depending on the selection for [Action].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Action]

The following shows selectable items.
• [Open a website]
• [Open a file in the public folder]
• [Make a phone call]

[URL]
Set the URL of a website to be accessed.
Specify the URL with one-byte alphanumerics and symbols within 2083 characters.

[Destination]

Displays the full path to the file to be opened in the GOT public folder.
If a message saying [The public folder is not set] appears, select [Allow external access to 
GOT public folder] in the [GOT Mobile Setting] window ([Basic Setting]).

➟10.19.6 ■1 [Basic Setting]

[File Path]

Set the relative path to the file to be opened in the GOT public folder (including sub folders).
Example) When opening Sample_001.pdf in the Project1 folder under the GOT public 
folder

For restrictions on the folder name and file name, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Action] is set to [Open a file in the public folder]

1)

4)

When [Action] is set to [Make a phone call]

When [Action] is set to [Open a website]

2) 3)
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2) [Shape]

3) [Preview]
Object preview

4) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Text] tab

You can select the text type to display the entered characters or a comment in a comment group on the object.

1) [Text Type]

For the setting of the comment group, refer to the following.
➟5.8 Comment Setting ([Comment])

The setting items differ according to the text type.
The following shows the setting items for each text type.

[Phone Number]
Set a phone number to be called.
Specify the phone number with one-byte numerics and no hyphen within 15 digits.

Item Description

[Shape]
Set a shape for the hyperlink object.
To select a shape other than those in the list box, click the [Shape] button.

[Frame Color] Set the frame color of the shape.

[Shape Color] Set the color of the shape.

Item Description

Item Description

[Text]

Displays the entered characters on the object.
If characters have already been entered in the [Text] field, switching the text type from 
[Text] to [Comment] enables you to register the entered characters in a comment group.
For the registration method for the comment group, refer to the following.
➟5.8.4 ■12 (2) Registering the characters in the [Text] field to a comment group

[Comment] Displays a comment of a specified comment group on the object.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) [Text]

1) [Text]
Enter characters to be displayed on the object.
Up to 1024 characters can be set.
To display the characters in multiple lines, press the [Enter] key at the end of a line.
(A line feed is counted as two characters.)

2) [Text Size]
Set the size of the text to be displayed on the object.
The setting range for the vertical and horizontal orientations is [8] dots to [240] dots (in 1-dot units).

3) [Text Color]
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

4) [Alignment]

Item Description

[Text Color]
Set the text color.
➟6.4 Color Settings

[Bold] button Displays the text in bold.

[Solid] button Displays the text with a shadow.

[Raised] button Displays the text embossed.

[Solid Color] When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Alignment] Set the vertical and horizontal positions of the text.

[Line Space] Set the space between lines in units of dots.
The setting range is [0] dots to [128] dots.

1)

2)

4)

3)

[Solid] button
[Raised] button

[Bold] button
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(2) [Comment]

1) [Comment Group]

2) [Comment]

Item Description

[Group No.] Set the comment group number to be used.
The setting range is [1] to [500].

[Adjust Text Size]
Automatically adjusts the text size according to the object size.
When this item is not selected, a line feed is automatically inserted if the text is more than 
one line.

[Minimum Size] Set the minimum text size applied when the text size is automatically adjusted.
The setting range is [8] dots to [240] dots.

Item Description

[Comment No.]

Set the comment number to be displayed.
The setting range is [0] to [32767].
To edit the comment to be displayed, click the [Edit] button to display the [Edit Comment] 
dialog.
If you specify an unregistered comment group number or comment number, a comment is 
newly created.

• [Column No.]
Select the column number of the comment to be edited.

• [Comment]
Edit the specified comment.
If an unregistered comment group number, comment number, or column number is 
specified, enter a new comment.
Up to 1024 characters can be set for the comment.
The numbers of characters, digits, and lines of the comment are displayed on the upper 
right above the comment entry field.

• Number of characters:
A one-byte or two-byte character is counted as one character. A line feed is counted as 
two characters.

• Number of digits:
A one-byte character is counted as one digit, and a two-byte character is counted as two 
digits. Among the lines, the largest number of digits is displayed.

• Number of lines:
The number of lines of the comment is displayed.
If only a line feed is inserted, it is counted as one line.

3)

1)

2)

4)
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3) [Alignment]

4) [Preview]

[Text Size]
Set the size of the text to be displayed on the object.
The setting range for the vertical and horizontal orientations is [8] dots to [240] dots (in 1-
dot units).

[Change Attribute of Comment Setting]

Change the comment attributes.
Set the color and style of the text to be displayed on the object.
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Text Color]
Set the text color.
➟6.4 Color Settings

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

• [Solid Color]
When [Solid] or [Raised] is selected as the text style, set the color of the shadow.

Item Description

[Alignment] Set the vertical and horizontal positions of the text.

[Line Space] Set the space between lines in units of dots.
The setting range is [0] dots to [128] dots.

Item Description

[Column No.] Set the column number of the comment to be displayed on the object on GT Designer3.

Item Description

[Solid] button
[Raised] button

[Bold] button
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■3 [Extended] tab

1) [Security Level]
Set a security level when using the security.
The setting range is [0] to [15].
If you do not use the security, select [0].

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
2) [Category]

Select the category to assign the object.
➟11.7 Managing figures and objects by category

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Trigger] tab

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.
Select the ON/OFF status of the set device to display the object.
The following shows selectable items.

• [ON Display]
• [OFF Display]
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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9. FUNCTIONS RUNNING IN THE 
BACKGROUND

9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm]) . . .9 - 2
9.2 Collecting Device Data ([Logging]) . . . . . . . . . . . . . . . . . . . . . . . . .9 - 156
9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9 - 198
9.4 Transferring Data between Devices ([Device Data Transfer])  . . . .9 - 267
9.5 Operating a Device as a Trigger ([Trigger Action]) . . . . . . . . . . . . .9 - 286
9.6 Operating the Set Time as a Trigger ([Time Action])  . . . . . . . . . . .9 - 301
9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard Copy])

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9 - 311
9.8 Controlling Operations with Scripts ([Script])  . . . . . . . . . . . . . . . . .9 - 334
9.9 Project Script, Screen Script, and Script Part . . . . . . . . . . . . . . . . .9 - 337
9.10 Object Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9 - 441
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9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

9.1.1 Overview of the alarm function

■1 Alarm type
The GOT collects the following alarms.

(1) User alarm

This function displays a comment created by user as an alarm massage when an alarm occurs.
Use this function when displaying an alarm created by a user.

(2) System alarm

This function displays the error code and the error message when an error occurs in the GOT, controller, or network.
Use this function when displaying an error occurred in the GOT, controller, or network.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

M100: OFF → ON
M101: OFF → ON

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error　
occurred

400 The communication 

with CPU failed. 16:40:30

9  AC down has been detected.

803 The transient error has occurred.
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■2 Available functions in the alarm
The GOT collects and displays alarms as follows.

(1) Displaying the comment set previously at the alarm occurrence
You can register any comment for the user alarm.

(a) Displaying comments by level in the hierarchy
The user alarm function displays the comment for one alarm in the upper alarm comment, middle alarm comment, or 
basic alarm comment.

➟9.1.5 ■4 (1) [Alarm Setting] tab
This enables you to check the alarm from the overview to the detail.

(b) Displaying the comment by switching the language
By setting multiple languages in a comment group, you can switch the display language with the language switching 
device.

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

M100: OFF → ON
M101: OFF → ON

Set any comment. Display Detail display

Detail

Touch

Error date and time Comment

Jun. 1, 2013 Temperature anomaly

Jun. 1, 2013 Fuse error

Switch from the upper to the middle.

Switch from the middle to the basic.

Factory

Device A Device B

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit
Drive

module
Control

unit

An error occurs.An error occurs.An error occurs.

Line1

Line2

Displays the upper alarm.

Displays the alarm 
occurrence status of the 
production line.

Displays the middle alarm.
Displays the alarm 
occurrence status of 
line2.

Displays the basic alarm.
Displays a unit where an 
alarm is occurring and 
the alarm contents 
of the device B.

Checked

Error date and time Comment

Jun. 1, 2013 Line1 error

Jun. 1, 2013 Line2 error

Checked

Error date and time Comment

Jun. 1, 2013
An error occurs 
in the device A.

Jun. 1, 2013 An error occurs 
in the device B.

Checked

Error date and time Comment

Jun. 1, 2013
Power supply 
unit error

Jun. 1, 2013
An error has occurred 
in the control unit.

Touch

Touch
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For setting comments, refer to the following.
➟5.8 Comment Setting ([Comment])

For the language switching settings, refer to the following.
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

(2) Checking the working status of the equipment by displaying the alarm information
The alarm function displays the following items.

• Occurred time
• Comment
• Restored time
• Checked time

• Cumulative Time*1

• Frequency
• Alarm status

• Down Time*2

• Level*3

• Group*3

*1 The total of alarm occurrence times.
*2 The time from the alarm occurrence to the restoration.
*3 By setting the level or group for each alarm, the display contents can be narrowed.

By the information above, you can understand the working status of the equipment and you can identify the cause of the 
deterioration of productivity.

(3) Operating the display contents
(a) Changing the display order by the setting

Set the display order for the displayed alarms.

発生日時 コメント

13/6/1 09:45:30 ヒューズエラー
13/6/1 08:15:45 オイルエラー
13/6/1 05:22:35 燃料エラー

13/6/1 11:35:52 温度異常

日本語 English

Occurred Comment

13/6/1 09:45:30 Fuse error
13/6/1 08:15:45 Oil error
13/6/1 05:22:35 Fuel error

13/6/1 11:35:52 Temperature is abnormal

日本語 English

1 2Language switching device: Language switching device:

Comment group setting

Setting comment group No.2 to commentsSetting comment group No.1 to the title row

Switching between comment column numbers with the language switching device

Title row

Comment
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You can sort the display order by the ascending order or the descending order of either of following conditions.
• Error date and time
• Comment
• Alarm status
• Restored
• Checked
• Frequency
• Cumulative Time
• Down Time
• Level
• Group

Example) When displaying alarms in the descending order of the date of alarm occurrence

The display order can be changed by the device value.
➟9.1.1 ■2 (3) (b) Operating the alarm display by device

(b) Operating the alarm display by device
• Displaying or hiding the alarm

You can display or hide the alarm by the device.

• Narrowing the display contents
You can narrow the display contents by the device.

Error date and time Comment

Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Jun. 1, 2013 05:22:35 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly

The display items can be 
changed by the setting.

The display order can be set.

11:35:52

 09:45:30   

08:15:45 09:30:18
 

05:22:35 11:35:52
 

04:33:12
  

 
02:30:16 19:18:20

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Temperature anomaly

Fuse error

Oil error

Fuel error

Internal pressure error

Motor error

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

11:50:57

13:30:14

18:46:49

CommentError date and time Restored CommentError date and time Restored

11:35:52

 09:45:30   

08:15:45 09:30:18

 05:22:35 11:35:52

 04:33:12   

 02:30:16 19:18:20Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

Motor error

Fuse error

Internal pressure error 

Temperature anomaly

Fuel error

Oil error

18:46:49

13:30:14

11:50:57

Displaying in order of the occurred date Displaying in order of the restoration date

D10: 0 D10: 1

Displays the alarm. Hides the alarm.

M100: OFF → ON M100: ON → OFF

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

M100 Temperature anomaly
M101 Fuse error
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By setting the level or group for each alarm, the display contents can be narrowed.
Two or more items can be set for narrowing the display contents.

(c) Setting a display color for the alarm contents
By displaying different character colors for each alarm, you can distinguish the alarm type visually.
The character color can be set only for the alarm popup display.

(d) Displaying the alarm only at the alarm occurrence
By using the alarm popup display, you can display the alarm only at the alarm occurrence without arranging the alarm 
display object.
When an object is placed on the alarm display position, the alarm is displayed.
Touching the alarm popup display on the screen switches a screen or level in the hierarchy, or displays the detail display.

(e) Scrolling comment display
The comments at the alarm occurrence are displayed by scrolling across the screen from right to left.
This function displays whole comments even when the display area is narrow.

Displaying by narrowing alarms in group 2

Example)
Set Device A to Group 1 and
set Device B to Group 2.

Error date and time Comment Group

Jun. 1, 2013 09:45:30 Oil error

Jun. 1, 2013 08:15:45 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly

2

2

2

Error date and time Comment

Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Jun. 1, 2013 05:22:35 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly

Alarm types can be 
visually identified.

A 1254

B 348

A 1254

B 348

Error occurred

Touch

A 1254

B 348

A 1254

B 348

Error

Displays alarms regardless of the screen size 
(scrolling across the screen from right to left).

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Checked

Screens and levels in the hierarchy 
can be switched.
9 - 6 9. FUNCTIONS RUNNING IN THE BACKGROUND
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(f) Writing the alarm information to devices
You can write the touched alarm information to a device.
The following shows the writable information.

• Alarm ID
• Comment group No.
• Comment No.
• Alarm status
• Occurrence date
• Occurrence time
• Date of restoration
• Time of restoration
• Date of confirmation
• Time of confirmation
• Level
• Group
• Frequency
• Cumulative Time
• Down Time

The detail message of the selected alarm can be displayed in the comment display.
In addition, the contents that cannot be displayed due to a narrow screen can be written to the device.

(g) Setting any alarm monitor device
The alarm monitor device can be set by the user.
Set the monitor device (alarm monitor) and the alarm display in different screens.

• Configuring multiple monitor device settings (alarm monitor) and displaying on one screen by switching the screen

Error date and time Comment

Jun. 1, 2013

Jun. 1, 2013

Jun. 1, 2013

An error has 

An error has 

An error has 
Error date and time Comment

Jun. 1, 2013 An error has occurred in

Jun. 1, 2013 An error has occurred in

Jun. 1, 2013 An error has occurred in 

Error date and time Comment

Jun. 1, 2013 the drive module.

Jun. 1, 2013 the control unit.

Jun. 1, 2013 the power supply unit.

Comments are displayed by scrolling 
across the screen from right to left.

The alarm in line1 has been selected.

Jun. 1, 2013 10:30 Temperature anomaly

A 1254

B 348

A 1254

B 348

Touch

Switches comments to be displayed 
by the written device values 
(by using the comment display).
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• Arranging various displays by one monitor device setting (alarm monitor)

(h) Storing the alarm data (power failure backup)
By storing the alarm data as alarm log files, the alarm histories can be stored even when the GOT is powered off.

• Storing the alarm data in data storage
You can store the user alarm history and the system alarm history in data storage.
Set whether to store or not each monitor device of the user alarm and the system alarm, and set the folder name and 
file name for each user alarm history and the system alarm history.
Set the timing for the storage from any of the rise, fall, cycle, ON sampling, or OFF sampling with the device.
When an alarm log file exists in the data storage, the alarm data in the data storage are read automatically when the 
GOT is powered on from off.

• Storing the alarm data in SRAM user area
You can store the user alarm history and the system alarm history in SRAM user area.

+

User alarm setting: Up to 300
System alarm setting: 1

Alarm Observation Alarm display Display

Set for displaying an alarm 
with alarm ID 1

Set GD0 for the alarm ID 
switching device 
(User alarm observation).

GD0 = 1: Displays the alarm with the alarm ID 1
GD0 = 2: Displays the alarm with the alarm ID 2
GD0 = 3: Displays the alarm with the alarm ID 3

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Switch

Alarm ID 3

Alarm ID 2

Alarm ID 1

+

Alarm Observation Alarm display

Display

Multiple lines display

Single line display

Error date and time Comment

Jun. 1, 2013 Temperature anomaly

Alarm ID 1 Set for displaying an alarm 
with alarm ID 1 
(Single line display)

Set for displaying an alarm 
with alarm ID 1 
(Multiple lines display)

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Error date and time Comment

Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Jun. 1, 2013 05:22:35 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly

Alarm data 
can be stored 
in a data storage!
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The latest alarm data are stored.
Set whether to store or not each monitor device of the user alarm and the system alarm.
When an alarm log file exists in the SRAM user area, the alarm data in the SRAM user area are read automatically 
when the GOT is powered on from off.

(i) Utilizing the stored data
The stored alarm log files can be displayed and edited in a personal computer, and displayed in a graph in the GOT.

• Outputting the alarm log files to a Unicode text file or a CSV file
The alarm data can be output to a Unicode text file and a CSV file.
The output alarm data can be displayed and edited on a personal computer.
To display and edit the alarm data on a personal computer, store the Unicode text file or the CSV file into the personal 
computer.
To read the resource data with GT Designer3, refer to the following.

➟4.3.2 ■3 Reading the data from the GOT
To read the CSV file stored in the data storage to the personal computer, refer to the following.

➟4.5 Transferring the Data with Data Storage

• Converting the alarm log file stored in the data storage
The alarm log file can be converted into a CSV file or a Unicode text file.
For the conversion with the utility of the GOT, refer to the following.

➟GOT2000 Series User's Manual (Utility)
For the conversion with the conversion trigger device, refer to the following.

➟9.1.2 ■6 [User Alarm Observation List] dialog
For the conversion with GT Designer3, refer to the following.

➟9.1.2 ■8 [Alarm File Conversion] dialog

Error date and time Comment

Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Jun. 1, 2013 05:22:35 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly

Alarm data 
can be stored in 
the SRAM user area!SRAM

Error date and time Comment

Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Jun. 1, 2013 08:01:35 Fuel error

Jun. 1, 2013 11:35:52 Temperature anomaly CSV 
file

Unicode 
text file

When reading a CSV file
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9.1.2 Collecting alarms by monitoring devices

➟■1 Specifications of the user alarm observation
■2 How to use the user alarm observation
■3 Precautions for drawing
■4 Precautions for use
■5 [Alarm Common Setting] dialog
■6 [User Alarm Observation List] dialog
■7 [User Alarm Observation] dialog
■8 [Alarm File Conversion] dialog
■9 Relevant settings

In a user alarm monitor, the time when set conditions of devices set as the alarm detection are satisfied or comments as 
the user alarm data history to a built-in memory of the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Line No. 1
A 1254

B 348

A 1254

B 348

Buffering area

Stores the alarm data 
in the buffering area.

An alarm 
occurred!

M100: OFF → ON
M101: OFF → ON

The alarm detection condition 
set by the user is satisfied.
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■1 Specifications of the user alarm observation

(1) Alarm detection condition and range
(a) Detection condition

• Rising (OFF to ON) or falling (ON to OFF) of the bit device
• Word device value

(b) Collection cycle (monitoring cycle)
The user alarms can be collected and updated to a buffering area of the GOT in a cycle set by the user regardless of a 
displayed screen.
The following shows the setting range of the cycle.

• 0.1 second to 3600 seconds
• 0.5 second to 3600 seconds (GT23, GT21, and GS21)

(c) Setting range
• User alarm observation setting

A user alarm observation setting specifies a pattern of collecting alarms.
Each user alarm observation setting has an alarm ID, which is used to specify its corresponding setting as the target 
of the alarm display (user) or others.
Up to 300 user alarm observation settings can be set.
The setting range of the alarm ID is 1 to 32767.

• Alarm points
The alarm points refer to the number of monitored devices.
The setting range depends on the GOT model.
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 32767 devices can be set in one user alarm observation setting.
Up to 45000 devices can be set in one project.
For GT21 and GS21
Up to 2000 devices can be set in one project.

(2) Setting example

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Alarm ID: 1 (An alarm for the maintenance)

D10 > 40   [Supply oil]
D20 > 500 [Supply fuel]

Alarm ID: 150 (An alarm for an emergency)

M10: OFF → ON [LineA abnormal stop]
M20: OFF → ON [LineB abnormal stop]
M30: OFF → ON [LineC abnormal stop]
M40: OFF → ON [LineD abnormal stop]

Alarm ID: 300
M80: OFF → ON [Check a battery]
M81: OFF → ON [Check the 
                              hydraulic pressure]
M82: OFF → ON [Check the 
                              internal pressure]
M83: OFF → ON [Check a fuse]

Setting

Setting

Setting

Alarm detection condition: Values of 
word devices

Watch cycle                     : 3600 seconds
Alarm points                     : 50

Alarm detection condition: Bit devices
Watch cycle                     : 2 seconds
Alarm points                     : 4

Alarm detection condition: Bit devices
Watch cycle                     : 60 seconds
Alarm points                     : 4

Alarm detection conditions, collection cycles (observation cycle), 
and number of alarms for each alarm ID
Number of alarm ID numbers: 3 (No.1, No.150, and No.300)
Alarm points: 58 (No.1: 50, No.150: 4, No.300: 4)
9. FUNCTIONS RUNNING IN THE BACKGROUND
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■2 How to use the user alarm observation

(1) Alarm collecting procedure and alarm history collecting method
(a) Alarm collecting procedure

The user alarm observation collects user alarm data to the buffering area of the user area in the user-specified cycle 
regardless of the displayed screen.
For the data collection cycle, refer to the following.

➟9.1.2 ■1 Specifications of the user alarm observation
The buffering area stores the collected user alarms as histories temporarily, and displays them on the GOT as alarms.

• For how to delete the data in the buffering area, refer to the following.
➟9.1.2 ■2 (2) Storing and deleting the collected user alarm data

• The data to be stored in the buffering area of the user area differ depending on the history collecting method.

(b) Alarm history collecting method
The following shows the alarm history collecting method.

• History mode
Adds the alarm contents to the user area of the GOT for each alarm occurrence.

• Cumulative mode
Collects the latest alarm status and the alarm counts or time together for each alarm.

• Only the current alarm
Displays only the alarm in occurrence, and deletes the display after the alarm restoration.

For the setting of the alarm history collecting method, refer to the following.
➟9.1.2 ■7 [User Alarm Observation] dialog

Depending on the collecting method, the types of information collected differs.
Example) Alarm Display (User)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Displayed 
information

Description

History mode Cumulative mode
Alarms in the 

"Occurred" status 
only

(1) Date of 
occurrence Displays the date and time when an alarm occurs.

(2) Comment Displays the comment assigned to the alarm at the alarm occurrence.

(3) Alarm status

Displays the alarm status that is currently displayed.
• Occurred: The alarm has occurred. (The occurrence of the alarm has not been checked.)
• Checked: The occurrence of the alarm has been checked.
• Restored: The monitor target already recovered from the alarm.

Error date and time Comment

Jun. 1, 2013 14:46:49 Temperature anomaly

Jun. 1, 2013 13:30:14 Fuse error

Buffering area

 User area

Displays the user alarm data collected 
in the buffer area as alarms.

Use alarm data are collected in the 
buffering area in the user-specific cycle 
regardless of the displayed screen.

(1) (2) (3) (4) (5) (6) (8)(7) (9) (10)

Group

Jun. 1, 2013 Checked - 2 -- 1
Jun. 1, 2013 2 00:2000:40 2 1

Jun. 1, 2013 - - - 1 -- 1
1
2

Error date and time Alarm status Restored Checked Frequency Down TimeCumulative Time Level

16:10
18:30
20:00 Power supply unit error

Comment

Hydraulic pressure failure
Drive module error Checked 16:30 16:20

18:50
9 - 12 9. FUNCTIONS RUNNING IN THE BACKGROUND
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(c) Alarm display example
The following shows the examples for displaying alarms with the alarm display (user) for each alarm collecting method.

(4) Restored Displays the date and time when the monitor target recovered from the alarm.

(5) Checked

Displays the date and time when an alarm occurrence has been checked.
Check the occurrence of an alarm with the touch switch or device that is set for the alarm check.

➟9.1.2 ■7 (2) [Device] tab
9.1.5 ■2 (11) Touch switches for the alarm display
Example) Operation with a touch switch

(6) Frequency -
Displayed only for the accumulation mode.
Displays the number of error occurrence.

-

(7) Cumulative Time -

Displayed only for the accumulation mode.
Displays the total time of alarm occurrence including the past alarm 
occurrence time.

-

(8) Down time -
Displayed only for the accumulation mode.
Displays the time from the alarm occurrence to the alarm restoration.

-

(9) Level

Displays the levels set for alarms.
The alarms can be classified into the level according to the alarm importance.
You can display the alarm with higher level preferentially or display the alarms with specific level only.

➟9.1.2 ■2 (6) Useful operations and functions

(10) Group

Displays the groups set for alarms.
The alarms can be classified into groups according to the alarm contents.
You can display the alarms in order of the group or display the alarms with specific group only.

➟9.1.2 ■2 (6) Useful operations and functions

Displayed 
information

Description

History mode Cumulative mode
Alarms in the 

"Occurred" status 
only

- -

Restored Checked

Power supply unit error

Comment

- 19:00

Restored Checked

Power supply unit error

Comment
Checked

Key code: FFB4h or FFB5h

Time

ON ON ON

OFF OFF OFF

Cumulative Time

An alarm occurs. An alarm occurs. An alarm occurs.
(Third time)(Second time)(First time)

Alarm 
occurrence 
status
(M10)

Down 
time A

Down 
time B

Down 
time C

Temperature anomaly
(M10: OFF → ON)

Fuse error
(M20: OFF → ON)

OFF OFF

Alarm check 
by a user

ON ON

ON

11:30
(1)

12:00
(2)

15:30
(3)

18:25
(4)

19:00
(5)
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• Historical
Collects the alarm occurrence status as histories.
The history is added every time an alarm occurs.

Jun. 1, 2013
Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

Cumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

10:25
11:30
18:25 Temperature anomaly

Comment

Temperature anomaly

Fuse error

15:30
19:00

12:00

(5) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30
18:25 Temperature anomaly

Comment

Temperature anomaly

Fuse error

15:30 12:00

(4) The restored temperature anomaly 
occurs again.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
15:30 12:00

(3) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
12:00

(2) A temperature anomaly has checked.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
12:00

(1) A temperature anomaly occurs.

A temperature 
anomaly occurs.

Displays the alarm 
adding a row newly.

A temperature anomaly 
has checked.

Displays the restored time.

Displays the restored time.

These items are not collected in the historical.

Checked

Key code: FFB4h
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• Cumulative
Collects the latest alarm status, the alarm counts, and the time together for each alarm.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

Cumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

10:25
18:25 Temperature anomaly

Comment

Fuse error
19:00

12:00

(5) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
18:25 Temperature anomaly

Comment

Fuse error 12:00

(4) The restored temperature anomaly 
occurs again.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error

15:30 12:00 04:00

00:35

12:00

(3) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
12:00

(2) A temperature anomaly has checked.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
00:001

1

1

1

1
1

2
1

2
1

00:00

04:00
00:00

04:35
00:00

00:00
00:00

04:00
00:00

(1) A temperature anomaly occurs.

A temperature 
anomaly occurs.

Displays the alarm occurred time 
of the alarm that occurred again 
in the same line, and frequency 
is added by one.

A temperature anomaly 
has checked.

Displays the restored time, 
the down time, 
and the cumulative time.

Displays the restore time, downtime, 
and cumulative time (total time during 
which the alarm has occurred).

Checked

Key code: FFB4h
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• Alarms in the "Occurred" status only
Collects the alarms that are currently occurring only.
The histories of the alarms that have been recovered are not stored.

(2) Storing and deleting the collected user alarm data
The user alarm data are stored in the buffering area in the user area of the GOT.
The stored user alarms are deleted at the following timing.

(a) When turning on the buffering data clear trigger device
Turn on [Buffering Data Clear Trigger Device] set in the [Basic] tab of the [User Alarm Observation] dialog to delete all 
alarm data in the "Restored" status.

➟9.1.2 ■7 [User Alarm Observation] dialog

(b) When inputting a key code for deletion using a touch switch
Use a touch switch to delete one or all alarm data items in the "Restored" status.

➟9.1.2 ■2 (6) Useful operations and functions

Jun. 1, 2013

Error date and time Restored Checked Frequency Down TimeCumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

Cumulative Time

10:25

Comment

Fuse error

(5) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
18:25 Temperature anomaly

Comment

Fuse error

(4) The restored temperature anomaly 
occurs again.

Jun. 1, 2013
Error date and time Restored Checked Frequency Down TimeComment

10:25 Fuse error

(3) A temperature anomaly has restored.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
12:00

(2) A temperature anomaly has checked.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked Frequency Down Time

10:25
11:30

Comment
Temperature anomaly

Fuse error
12:00

(1) A temperature anomaly occurs.

A temperature 
anomaly occurs.

Displays alarms that 
has occurred again

A temperature anomaly 
has checked.

Deletes the restored alarms.

Deletes the restored alarms.

Not collected if only the alarms in the "Occurred" status are displayed.

Checked

Key code: FFB4h

Turning on the buffering 
data clear trigger device

Delete
Jun. 1, 2013 10:25 Drive module error

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Jun. 1, 2013 11:30 15:30Hydraulic pressure failure

15:00

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Jun. 1, 2013 10:25 Drive module error

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Key code: Delete one event. FFB6h.
      Delete all events. FFB7h.

Delete
Jun. 1, 2013 10:25 Drive module error

Jun. 1, 2013 09:10 Control unit error

Error date and time Comment Restored

Jun. 1, 2013 11:30 15:30Hydraulic pressure failure
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(c) When powering off or resetting the GOT
Power off or reset the GOT to delete alarm data.
However, when the alarm data is stored in a data storage, the data is retained even after the GOT is powered off.

(d) When changing the [Controller] setting in the utility
Change the [Controller] setting in [GOT basic set] in the utility to delete all alarm data in the "Restored" status.

(e) When writing/deleting data to/from the GOT
Perform any of the following operations in the [Communicate with GOT] dialog to delete all alarm data in the "Restored" 
status.

• Writing package data
• Deleting an item from the drive information
• Formatting a drive

(3) Power failure backup for the user alarm
(a) Overview of the power failure backup

Once the user alarm data are stored in the data storage or the SRAM user area as the alarm log file, the user alarm data 
are held even when the GOT is powered off.
When the alarm log file is stored in the data storage or the SRAM user area when the GOT is powered on, the alarm log 
file is read automatically and the user alarm history before the power-off is restored.

• Precautions for starting the GOT
When reading and restoring the user alarm from the data storage, install the data storage on the GOT before 
powering-on the GOT.
After the powering-on the GOT, the data in the data storage cannot be restored.
In addition, when the data storage is installed after the power-on, the user alarm data in the data storage are 
overwritten when other user alarm data are stored in the data storage.

(b) Performing the power-failure backup
To hold the data in the data storage, configure the setting in the [File Save] tab of the [User Alarm Observation] dialog, 
and use either of the following methods.

• Storage by the store trigger device
➟9.1.2 ■7 [User Alarm Observation] dialog

• Storage by the touch switch
➟9.1.5 ■2 (11) Touch switches for the alarm display

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC
DDDEEEFFF
DDDEEEFFF

Data storage
• The timing with which alarms are saved in the data storage can be set.

(Rise, Fall, Sampling, ON Sampling, or OFF Sampling)

• Data can be saved with touch switch inputs.

Power OFF Power ON
Displays the status that 
was saved before power-off 
and the current status.

Status that was saved before power-off
Current status

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC
DDDEEEFFF
DDDEEEFFF

SRAM user area

Power OFF Power ON
Displays the status that 
was saved before power-off 
and the current status.

Status that was saved before power-off
Current status

• Stores the alarm data stored 
in the buffering area into the SRAM user area.
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• Storage by the Buffering And File Access Control: Forcefully Save Buffered Data signal (GS520.b0)
➟12.1 GOT Internal Device

To hold the data in the SRAM user area, configure the setting in the [Basic] tab of the [User Alarm Observation] dialog.
Up to 10 user alarm observation settings can be configured with the SRAM power-failure backup function enabled.

• Saving data to the SRAM user area
➟9.1.2 ■7 [User Alarm Observation] dialog

(c) Information to be stored
The information in the alarm log file to be stored in the data storage and the SRAM user area differ depending on the 
alarm collecting method.

➟9.1.2 ■1 Specifications of the user alarm observation

(d) File name and storage timing
You can set any file name for each alarm ID.
You can set triggers (rise or fall) to perform the file save.

➟9.1.2 ■7 [User Alarm Observation] dialog

(e) Available memory capacity
The memory capacity used to retain the user alarms at power failure can be checked in the [Basic] tab of the [User Alarm 
Observation] dialog.

➟9.1.2 ■7 (1) [Basic] tab

(f) Backing up the alarm log file stored in the data storage
Select [Automatically backup at the time of saving] in the [File Save] tab of the [User Alarm Observation] dialog to store 
the alarm log file as a backup file when the alarm log file is saved.

(g) Backing up/restoring the data stored in the SRAM user area
Backup or restore the data stored in the SRAM user area by using the [SRAM control] of the utility.
For the details of the backup/restore, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(h) Monitoring the writing status
You can monitor the status during the user alarm data writing and a writing error by using a device.

➟9.1.2 ■7 [User Alarm Observation] dialog

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Temperature anomaly

Write operation 
in progress :

Write operation error: Save

The status of write operations can be monitored.

Write
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(4) Converting alarm log files
Alarm log files generated by user alarms are binary format files (*.G2A).
To display and edit the alarm log files on a personal computer, convert them into Unicode text files or CSV files.
The following shows how to convert the alarm log files.

(a) Creating a Unicode text file or a CSV file with the utility
Convert a binary format file (*.G2A) stored in the data storage into a Unicode text file or a CSV file with the utility.

Step 1 Select a (*.G2A) file in [Alarm information] of the utility and touch the [G2A→TXT] or [G2A→CSV] button.

Step 2 Store the created Unicode text file or CSV file into a personal computer by either of the following methods.
• Transferring with GT Designer3

Reads resource data from the GOT.

• Storing by using the data storage
Stores the alarm log file to the data storage and reads the alarm log file from the data storage.

Step 3 Display or edit the converted Unicode text file or the CSV file on a personal computer.
• For the operations of the utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Alarm log 
file

Alarm log 
file

Transfer with GT Designer3.

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Alarm log 
file

Alarm log 
file

Use the data storage.
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• To read the resource data from the GOT, refer to the following.
➟4.3.2 ■3 Reading the data from the GOT

(b) Converting a Unicode text file or a CSV file with the device
Turning on a specified device converts a binary format file (*.G2A) stored in the data storage into a Unicode text file or a 
CSV file.

Step 1 Configure the setting for control the alarm log file conversion with the device in the [Alarm Common Setting] 
dialog.

Step 2 Configure the setting for storing the alarm log file stored in the buffering area to the data storage in the [File 
Save] tab of the [User Alarm Observation] dialog.

• For how to configure the setting in the [Alarm Common Setting] dialog, refer to the following.
➟9.1.2 ■5 [Alarm Common Setting] dialog

• For the [File Save] tab setting of the [User Alarm Observation] dialog, refer to the following.
➟9.1.2 ■7 (3) [File Save] tab

• Precautions on converting files by using external control devices
Before converting the alarm log files, write the user alarm monitor ID that generates a file to the alarm 
ID specification device. When the conversion trigger device is turned on before the user alarm monitor 
ID is written, the alarm log file is not converted.
Always turn off the conversion trigger device after the alarm log file conversion.
When the alarm log file conversion is completed, the conversion notification device does not turn off 
when the conversion trigger device is on.
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(5) Configurations of a Unicode text file and a CSV file
(a) History mode

(b) Cumulative

No. Description

1) An alarm collecting method.

2) An alarm ID.

3) An alarm name.

4) The number of data points.

5) The basic comment group No.

6) The middle comment group No.

7) The upper comment group No.

8) The detailed comment group No.

9) The number of the alarm histories.

10) The number of unrestored alarms.

11) The number of unchecked alarms.

12) The order of the dates.

13) The difference between the Greenwich Mean Time and "Occurred"/"Restored"/"Checked".

14) The order of the output time.

15) The upper comment No.

16) The middle comment No.

17) The basic comment No.

18) The comment for a basic alarm.

19) Alarm status (O: Occurring, not confirmed; OC: Occurring, confirmed; R: Restored, not confirmed; RC: Restored, confirmed)

20) The date and time when an alarm occurs.

21) The date and time when an alarm has restored.

22) The date and time when an alarm occurrence has been checked.

23) The level set for an alarm.

24) The group set for an alarm.

16)15) 18) 21) 22) 23) 24)20)19)17)

1)
2)
3)
4)
5)
6)
7)
8)
9)
10)
11)
12)
13)
14)
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No. Description

1) An alarm collecting method.

2) An alarm ID.

3) An alarm name.

4) The number of data points.

5) The basic comment group No.

6) The middle comment group No.

7) The upper comment group No.

8) The detailed comment group No.

9) The number of the alarm histories.

10) The number of unrestored alarms.

11) The number of unchecked alarms.

12) The order of the dates.

13) The difference between the Greenwich Mean Time and "Occurred"/"Restored"/"Checked".

14) The order of the output time.

15) The upper comment No.

16) The middle comment No.

17) The basic comment No.

18) The comment for a basic alarm.

19) The alarm status. (O: Alarm has been occurring, but has not been confirmed, OC: Alarm has been occurring, and has been 
confirmed, R: Alarm has been restored, but has not been confirmed, RC: Alarm has been restored, and has been confirmed)

20) The date and time when an alarm occurs.

21) The date and time when an alarm has restored.

22) The date and time when an alarm occurrence has been checked.

23) The level set for an alarm.

24) The group set for an alarm.

25) The number of alarms.

26) The total time of alarm occurrence including the past alarm occurrence time (total downtime).

27) The time from the alarm occurrence to the alarm restoration.

1)
2)
3)
4)
5)
6)
7)
8)
9)

10)
11)
12)
13)
14)

15) 16) 18) 21) 22) 23) 24) 25) 26) 27)20)19)17)
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(6) Useful operations and functions
(a) Hierarchizing alarms

The following shows examples of hierarchizing alarms.

Setting example
Classify the comment for the occurrence of an alarm into three levels in the hierarchy: upper level, middle level, and basic 
level. Then set as follows.

• Narrowing the alarm location
The alarm can be displayed from the overview to the detail.

Device 
A

Device 
B

Line2

Device 
A

Device 
B

Line1

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Basic alarm

Middle alarm

Upper alarm

Setting in the [Device] tab of the [User Alarm Observation] dialog
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• Executing the check (FFB4h) and the deletion (FFB6h) to multiple alarms in a batch
The following operation can be executed to multiple alarms in the lower hierarchy in a bath.

Executing the check (FFB4h) or the deletion (FFB6h) in the upper alarms executes the same operation for the middle 
alarms and the basic alarms under the upper alarms.

Executing the check (FFB4h) or the deletion (FFB6h) in the middle alarms executes the same operation for the basic 

Operation Description

Check Records the date and time when an alarm occurrence has been confirmed.

Deleting a project Deletes the alarm history that has been restored.

Checked

An error has occurred in line2.
An error has occurred in line1.

Checked

An error occurs in the device B.
An error occurs in the device A.

Checked

An error has occurred in the control unit.

An error has occurred in the power supply unit.

Lower 
hierarchy

Upper 
hierarchy

(FFC2H)

(FFB8H)

Switch from the 
upper to the middle.

Switch from 
the middle to 
the upper.

Lower 
hierarchy

Upper 
hierarchy

(FFC2H)

(FFB8H)

Switch from the 
middle to the basic.

Switch from 
the basic to 
the middle.

Displays the basic alarm.
(Displays a unit where an alarm 
is occurring and the alarm 
contents of the device B.)

Displays the middle alarm.
(Displays the alarm occurrence 
status of line2.)

Displays the upper alarm.
(Displays the alarm occurrence 
status of the production line.)

Line2

Device A Device B

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Deleting 
a project

An error has occurred in line2.

An error occurs in the device B.
An error occurs in the device A.

An error has occurred in the drive module.

An error has occurred in the control unit.

An error has occurred in the power supply unit.

Displays the upper alarm.

Displays the middle alarm.

Displays 
the basic alarm.

Deleting 
a project

Touch
(FFB6h)

Restored alarm

Current alarm

Line2

Device A Device B

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Deleting 
a project

An error has occurred in line2.

An error occurs in the device B.

An error has occurred in the drive module.

Displays the upper alarm.

Displays the middle alarm.

Displays 
the basic alarm.

Restored alarm histories 
are cleared in a batch.
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alarms under the middle alarms.

• Reset operation
The operation to eliminate alarms (turning on to off or entering the reset value) manually by the reset (FFB9h) cannot 
be executed to multiple alarms in a batch.
Execute the resetting in the basic alarm display.

• Classifying alarms into levels or groups
The alarms can be classified into levels or groups.
You can display errors displayed at the error occurrence by narrowing in the alarm importance or the alarm type.
The following shows an example for narrowing an alarm display by changing the switching device value.
Configure the switching device setting in the [Alarm Display(User)] dialog.
For the details of the settings, refer to the following.

➟9.1.5 ■4 [Alarm Display(User)] dialog

Line2

Device A Device B

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Deleting 
a project

An error occurs in the device A.
An error occurs in the device B.

An error has occurred in the drive module.

An error has occurred in the control unit.

An error has occurred in the power supply unit.

Displays 
the middle alarm.

Displays 
the basic alarm.

Deleting 
a project

Touch
(FFB6h)

Restored alarm

Current alarm

Line2

Device A Device B

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Deleting 
a project

An error occurs in the device A.
An error occurs in the device B.

An error has occurred in the drive module.

Displays 
the middle alarm.

Displays 
the basic alarm.

Restored alarm histories 
are cleared in a batch.

Error date and time Comment Restored Checked

Jun. 1, 2013 10:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:05 An error has occurred in the drive module.

Jun. 1, 2013 12:35 An error has occurred in the control unit.

Error date and time Comment

Jun. 1, 2013 10:25 An error has occurred in the power supply unit. 13:00

Jun. 1, 2013 12:05 An error has occurred in the drive module.

Jun. 1, 2013 12:35 An error has occurred in the control unit.

Reset (FFB9h)

Execute the reset operation for each alarm.

Restored Checked
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(b) Display example of the basic alarm (detailed display)
In the basic alarm, the detailed information such as the cause or measure of the alarm in the comment window, the base 
screen, and the window screen.
Setting example

• Comment window
Displays a comment a user registers.
In the comment window, more detailed comments such as the measures for alarms are displayed.

• Base screen
Displays the specified base screen.

Error date and time Comment Level Group

Jun. 1, 2013 16:51 Hydraulic pressure failure 1 1

2 1

1 2

1 2

2 2

Jun. 1, 2013 14:25 Cooling water hydraulic pressure drop

Jun. 1, 2013 12:25 Supply oil

Jun. 1, 2013 09:40 The amount of the remaining feedstock is low.

Jun. 1, 2013 07:35 Supply fuel

Displaying alarms in the chronological order.

0

0

Level switching 
device 
(D32)

Group switching 
device 
(D33)

Error date and time Comment Level Group

Jun. 1, 2013 16:51 Hydraulic pressure failure 1 1

1 2

1 2

Jun. 1, 2013 12:25 Supply oil

Jun. 1, 2013 09:40 The amount of the remaining feedstock is low.

Only the alarms in the level 1 are displayed.

1

0

Level switching 
device 
(D32)

Group switching 
device 
(D33)

Error date and time Comment Level Group

1 2

1 2

Jun. 1, 2013 12:25 Supply oil

Jun. 1, 2013 09:40 The amount of the remaining feedstock is low.

Only the alarms in the group 2 are displayed.

1

2

Level switching 
device 
(D32)

Group switching 
device 
(D33)

Error date and time Comment

Jun. 1, 2013 16:13 An error has occurred in the power supply unit.

Jun. 1, 2013 15:51 An error has occurred in the drive module.

Jun. 1, 2013 10:25 An error has occurred in the control unit.

Error date and time Comment

Jun. 1, 2013 16:13 An error has occurred in the power supply unit.

Jun. 1, 2013 15:51 An error has occurred in the drive module.

Jun. 1, 2013 10:25 An error has occurred in the control unit.

Hydraulic pressure 

failure.

User alarm display

Base screen 1 Base screen 1 + comment window
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• Window screen
Displays the specified window screen (overlap window 1).

(c) When the buffering area is full
You can set a device for executing a notification when the number of alarms reaches to [Stored Number] set in the [Basic] 
tab of the [User Alarm Observation] dialog.

• Confirming the number of the alarm histories and the alarms
You can confirm the number of the alarm histories by storing the histories stored in the buffering area temporarily to 
a device.
The number of the user alarms that are currently occurring can be confirmed as well.

• When the buffering area is full
You can set a device for notifying the full of the buffering area.
To execute the notification before the buffer area becomes full, set [Full Notification Signal Device] in the [Basic] tab 
of the [User Alarm Observation] dialog.
Select the operation when the buffering area is full in [Action When Buffer is Full] in the [Basic] tab of the [User Alarm 
Observation] dialog.

Error date and time Comment

Jun. 1, 2013 16:13 An error has occurred in the power supply unit.

Jun. 1, 2013 15:51 An error has occurred in the drive module.

Jun. 1, 2013 10:25 An error has occurred in the control unit.

User alarm display

Base screen 1 Base screen 5

Tank control screenRUN

STOP

Base screen 1 + window screen 10

Error date and time Comment

Jun. 1, 2013 16:13 An error has occurred in the power supply unit.

Jun. 1, 2013 15:51 An error has occurred in the drive module.

Jun. 1, 2013 10:25 An error has occurred in the control unit.

User alarm display

Base screen 1

Error date and time Comment

Jun. 1, 2013 16:13 An error has occurred in the power supply unit.

Jun. 1, 2013 15:51 An error has occurred in the drive module.

Jun. 1, 2013 10:25 An error has occurred in the control unit.

Charge the feedstock 

from the slot.

Filler nozzle

Number of 
histories: Full:
Number of 
occurrences:

1254
2

Error date and time Comment

Jun. 1, 2013 13:30:14 Fuse error

Jun. 1, 2013 14:46:49 Temperature anomaly

Check the number 
of alarm histories 
and the occurrences.
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• Size of the buffering
The size of the buffering area to be used for the user alarm varies depending on the setting.
Increasing the size of the buffering decreases the user area of the GOT. Adjust the size of the buffering according to 
the user area capacity.
Setting items for the size of the buffering area

The size of the buffering area required for the set user alarm list can be confirmed in the [Basic] tab of the [User Alarm 
Observation] dialog.
For the details of the buffering area, refer to the following.

➟9.1.2 ■2 (1) Alarm collecting procedure and alarm history collecting method
For how to configure the setting in the [User Alarm Observation] dialog, refer to the following.

➟9.1.2 ■7 [User Alarm Observation] dialog

Alarm collecting method Setting for the size of the buffering area

History mode

• Number of devices set for the alarm ([Alarm Points] in the [Device] tab of the [User Alarm Observation] 
dialog)

• Number of alarm histories to be stored ([Stored Number] in the [Basic] tab of the [User Alarm 
Observation] dialog)

Cumulative
• Number of devices set for the alarm ([Alarm Points] in the [Device] tab of the [User Alarm Observation] 

dialog)Alarms in the "Occurred" 
status only

Number of 
histories: Full:
Number of 
occurrences:

1254
2

Error date and time Comment

Jun. 1, 2013 13:30:14 Fuse error

Jun. 1, 2013 14:46:49 Temperature anomaly

Full notification
9 - 28 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

■3 Precautions for drawing

(1) Setting for storing the user alarm data to data storage
To place a button for storing the user alarm data, configure either of the following settings.

• Set the store trigger device in the [File Save] tab of the [User Alarm Observation] dialog and store the user alarm data.
➟9.1.2 ■7 [User Alarm Observation] dialog

• Place a touch switch for the alarm display (user) on the screen where the alarm display (user) is set and store the 
user alarm data.

➟9.1.5 ■2 (11) Touch switches for the alarm display

(2) Available file size
Data storage must have larger capacity than the size of the file to be stored.
For the file size, refer to the following.

➟9.1.2 ■1 Specifications of the user alarm observation

(3) Comment group
If the nonexistent value (column No.) is stored in the language switching device, "No message" is not displayed.

(4) Changing the user alarm observation settings
After the first settings and any change of the following setting items, if you change the settings again or import settings 
from a CSV file, note the following:
The history data may be partially deleted or displayed incorrectly.
Before you change the setting, backing up the alarm files of the GOT is recommended.

• Alarm ID
• Collection Mode
• Stored Number
• Alarm Points
• Middle Comment No.
• Upper Comment No.

(5) Setting when using the mail send function
If you select [Only current alarm] for [Collection Mode] in the [User Alarm Observation] dialog ([Basic] tab), no e-mail is 
sent upon recovery from an alarm because the GOT does not monitor such events.
To send an e-mail upon recovery from an alarm, select an item other than [Only current alarm] for [Collection Mode].

➟9.1.2 ■7 [User Alarm Observation] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Precautions for use

(1) When the same data are stored in data storage

The data in the data storage are overwritten. To reserve the data, move the data in the data storage to a personal 
computer with either of following methods.

• Reading resource data with GT Designer3
➟4.3.2 ■3 Reading the data from the GOT

• Reading a CSV file stored in the data storage with a personal computer

(2) Alarm monitoring during the alarm log file saving
While the alarm log file is being saved in the data storage, the monitoring processing for the user alarm of the alarm ID 
that is being saved is stopped temporarily.
User alarms occurred or restored during the storing are not displayed.

(3) Storage by the Buffering And File Access Control: Forcefully Save Buffered Data signal (GS520.b0)
It may take minutes for an alarm log file to be saved in data storage because the data of all the target user alarms for the 
alarm log file is saved.
To prevent the monitoring from stopping for a long time, save the alarm log files in units of objects.

• Setting the store trigger for each user alarm observation setting
• Setting the touch switch (key code: FFBBh) for each alarm display (user)

(4) Precautions for removing an SD card
When you open the SD card cover or turn off the SD card access switch, the files are saved automatically.
Before removing the SD card, make sure that the file saving is complete by checking one of the following conditions.

• The Drive Status Notification signal (system signal 2-2.b0, b1) is turned off.
• The SD card access LED is turned off.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Save

AAM00000.G2A

Save

AAM00000.G2A

Overwritten!

Touch!

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Save

Saving...

Buffering area

 User area

Alarm ID 1

Alarm ID 2

Alarm ID 3

While the alarm log file is being 
saved in the data storage, 
the monitoring processing for 
the user alarm that is being saved 
is stopped temporarily!
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➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])
Storing may take longer because all the user alarms and system alarms for saving the alarm log files are stored.

(5) Restoring the alarm histories when powering-off to on the GOT
When the alarm log file in the data storage is not created in the project in the GOT, the file cannot be read from the GOT.
In this case, an alarm occurs or a device turns on.

• A system alarm 525 occurs.
• The [Writing Error Notification Device] set in the [File Save] tab of the [User Alarm Observation] dialog turns on.

(6) Collecting alarms when the buffering area is full
The operation when the buffering area is full is either of the followings according to the [Action When Buffer is Full] in the 
[Basic] tab of the [User Alarm Observation] dialog.

• Deleting restored user alarms and adding a new user alarm
• The user alarms are not collected.

To prevent the operations above, set the [Full Notification Signal Device] in the [Basic] tab of the [User Alarm Observation] 
dialog and delete the restored alarm when the device turns on.

➟9.1.2 ■7 [User Alarm Observation] dialog

(7) Error occurred during the alarm log file saving
When an error occurs during the alarm log file saving, the [Writing Error Notification Device] set in the [File Save] tab of 
the [User Alarm Observation] dialog turns on.
If the Writing Error Notification device turns on, check that the following conditions are satisfied.

• The SD card cover of the GOT is closed.
• The SD card access switch of the GOT is turned on.
• The data storage works normally.

The user needs to turn off this device.

(8) Difference from the Drive status notification signal (writing device: system signal 2-2)
The full notification, writing notification and a writing error can be notified by the Drive status notification signal as well, 
and the operations differ from the devices set in the user alarm monitoring.

(9) Character code and conversion destination file
If an alarm log file contains any character other than ASCII and Shift JIS characters, convert the file as shown below.

• Convert the file to Unicode text format.
• Turn on the Character Code for CSV Conversion signal (GS522.b2), and convert the file to CSV format.

(10)Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(11)Changing the alarm history collecting method
If you change the alarm history collecting method of a project, and then write the project to a GOT on which the user alarm 
observation is running, the alarm history may be incorrectly displayed.
Before changing the alarm history collecting method, delete alarm log files (*.G2A).

Item
Operation (difference)

User alarm observation Drive status notification signal

Difference between [Full Notification Signal Device] 
set for user alarm monitors and the Drive status 
notification signal (System signal 2-2.b4, b5)

Turns on when the number of log files reaches 
the [Stored Number] set in the [Basic] tab (when 
the buffering area reserved for the user alarms 
is full).

Turns on when the data storage is full.

Difference between [Writing Notification Device] set 
for user alarm monitors and the Drive status 
notification signal (System signal 2-2.b0, b1)

Turns on while the user alarm data are written to 
the data storage.

Turns on while the data are written to the data 
storage (turns on while data other than the 
user alarm are written).

Difference between [Writing Error Notification Device] 
set for user alarm monitors and the Drive status 
notification signal (System signal 2-2.b7, b8)

• Turns on when an error occurs at the 
accessing to the alarm log file in the data 
storage (when the alarm log file in the data 
storage is not created in the project in the 
GOT).

• Turns on when the data storage cannot be 
accessed (e.g. when a data storage is not 
installed or the SD card cover is open).

Turns on when the data storage cannot be 
accessed (e.g. when a data storage is not 
installed or the SD card cover is open).
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(12)To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

■5 [Alarm Common Setting] dialog

Configure this setting when controlling the alarm log file conversion by devices.
Select [Common] → [Alarm] → [Alarm Common Setting] from the menu to display the [Alarm Common Setting] dialog.
To control the alarm log file conversion by devices, configure the [File Convert] setting in the [File Save] tab of the [User 
Alarm Observation] dialog.

➟9.1.2 ■7 [User Alarm Observation] dialog

1) [Save the alarm logs and convert them into Unicode Text/CSV (project common)]
Configure this setting for controlling the alarm log file conversion by devices.

2) [Conversion Trigger Device]
Set trigger devices for the file conversion.

3) [Alarm ID Device]
Set the device that specifies the alarm monitoring ID for generating a conversion target file.

4) [Conversion-in-motion Notification Device]
Set the device to notify that a file is being converted.
After the alarm log file conversion is started, make sure to turn off the conversion trigger device.
If the conversion trigger device is on even after the conversion is complete, the conversion notification device does 
not turn off.

5) [File Conversion Language]

Item Description

User alarm

Set the row No. of the comment group to be used in the file conversion.
[Change with language switching device]:
Converts files with a row No. switched by the language switching device.
[Fixed column No.]:
Converts files with a set row No.
The setting range is [1] to [30].

System alarm

Not available to GT21 and GS21.
Set the system language to be used for the file conversion.
[Change with system language switching]:
Converts files in the system language displayed on the GOT.
[Fixed language]:
Converts files with a set language.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)
2)

4)

5)
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■6 [User Alarm Observation List] dialog

Select [Common] → [Alarm] → [User Alarm Observation] from the menu to display the [User Alarm Observation List] 
dialog.
Configure the user alarm observation settings (devices to be monitored, monitoring cycle, and alarm collection mode) for 
each alarm ID.
Up to 300 alarm IDs are settable.

1) [New] button
Displays the [User Alarm Observation] dialog to set a new alarm ID.

➟9.1.2 ■7 [User Alarm Observation] dialog
2) [Edit] button

Displays the [User Alarm Observation] dialog to configure the setting of selected alarm ID.
➟9.1.2 ■7 [User Alarm Observation] dialog

3) [Copy] button
Copies a selected alarm ID.

4) [Paste] button
Pastes the copied alarm ID to the alarm ID list.

5) [Delete] button
Deletes a selected alarm ID.

6) [Delete All]] button
Deletes all selected alarm ID.

7) [Alarm Common Setting] button
Displays the [Alarm Common Setting] dialog.

➟9.1.2 ■5 [Alarm Common Setting] dialog

• [Destination Alarm ID]
Set the copy destination of the copied alarm ID.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)

4)

5)

6)

7)
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■7 [User Alarm Observation] dialog

Step 1 Select [Alarm] → [User Alarm Observation] → [New] from the project tree.
Step 2 Double-click the [New] to display the [User Alarm Observation] dialog.

➟(1) [Basic] tab
(2) [Device] tab
(3) [File Save] tab
(4) [Extended] tab
(5) [External Output] tab
(6) [Alarm Hierarchy Setting] dialog
(7) [Additional Setting] dialog
(8) [Alarm Print Detail Setting] dialog
(9) [Mail Send Language Setting] dialog
(10) [Copy User Alarm Observation] dialog

(1) [Basic] tab

Set the alarm history collecting method and the buffering that stores the alarm history.

1) [Alarm ID]
Set the alarm ID of the user alarm.
The setting range is [1] to [32767].

2) [Alarm Name]
Set an alarm name of the user alarm.
Up to 32 characters can be set as an alarm name.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)

4)

3)

When [Cumulative] is selected for the [Collection Mode].
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3) [Basic]

4) [Buffering]
Configure settings for the buffering that stores the collected user alarms.

Item Description

[Collection Mode]

Select a user alarm collecting method.
• [Historical]:

Collects the user alarm occurrence status as histories.
Adds a history every time an alarm occurs.

• [Cumulative]:
Collects the latest user alarm status and the user alarm counts or time together for each 
user alarm.

• [Only current alarm]:
Collects the alarms that are currently occurring only.
The history of the user alarms that have been restored are not stored.

[Display the same alarm occurring multiple 
times as another item]

This item can be set only when the [Collection Mode] is [Cumulative]. 
Displays the same alarm, which occurred multiple times, as another item at each time of 
occurrence.

[Pop up alarms]

Pops up a user alarm message.
Configure the following settings additionally.
• Alarm popup display settings

➟9.1.4 ■4 [Alarm Popup Display] dialog
• Setting of the screen where an alarm message pops up

➟2.7.1 ■1 [Basic] tab
10.19.7 ■1 [Basic] tab

Item Description

[Retain data in the embedded memory in GOT 
even when the power goes off (The battery 
will be required)]

Not available to GT21 and GS21.
Saves alarm data in the buffering area in the SRAM user area.
Up to 10 user alarm observation settings can be configured with the SRAM power-failure 
backup function enabled.

➟9.1.1 ■2 (3) (h) Storing the alarm data (power failure backup)

[Stored Number]

Set this item when setting [Collection Mode] to [Historical].
Set the number of user alarm history events to be stored.
The setting range depends on the GOT model.
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [Alarm Points] set in the [Device] tab to [32767].
For GT2107-W, GT2105-Q, GT2104-R, and GT2104-P
The setting range depends on the drive in which events are stored.
• Drive D: [Alarm Points] set in the [Device] tab to [1000]
• Other drives: [Alarm Points] set in the [Device] tab to [2000]
For GT2103-P and GS21
The setting range depends on the drive in which events are stored.
• Drive C: [Alarm Points] set in the [Device] tab to [1000]
• Other drives: [Alarm Points] set in the [Device] tab to [2000]
The buffer size increases as the number of the stored events increases.

[Action When Buffer is Full]

Set this item when setting [Collection Mode] to [Historical]. 
Select the operation executed when the number of the user alarms stored in the buffering 
area reaches the [Stored Number].
• [Delete old data]:

Deletes the user alarm with the oldest restoration date from the restored user alarms, and 
collects a new user alarm.

• [Add no item]:
Stops collecting the user alarms and does not collect a new user alarm.

[Full Notification Signal Device]

Set this item when setting [Collection Mode] to [Historical]. 
Notifies that the storable number of user alarm histories becomes the number set in the 
[Notification Number] or less by the set device.
➟6.1.2 How to set devices

[Notification Number]

When setting [Full Notification Signal Device], set this item. 
Set the number of the user alarm histories for which the [Full Notification Signal Device] is 
notified. 
The setting range is [0] to [255].
• Setting example

When the [Stored Number] is set to 1000, the [Notification Number] is set to 10 
The [Full Notification Signal Device] turns on when the number of stored user alarm 
histories becomes 990 because the number of storable user alarm histories becomes 10.

[Buffering Data Clear Trigger Device]
Deletes the restored user alarms stored in the buffering area by the set device.
➟6.1.2 How to set devices
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(2) [Device] tab

Configure settings for the timing for collecting user alarms or user alarm settings (devices set for user alarms, comments 
displayed at a user alarm occurrence, resetting user alarms, and level/group setting).

1) [Watch Cycle]
Set a cycle at which the device is monitored.
The following shows the setting range.

• [1] to [36000]
• [5] to [36000] (GT23, GT21, and GS21)

2) [Alarm Points]
Set the number of alarms.
The setting range depends on the GOT model.
For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [32767].
For GT2107-W, GT2105-Q, GT2104-R, and GT2104-P
The setting range depends on the drive in which events are stored.

• Drive D: [1] to [1000]
• Other drives: [1] to [2000]

For GT2103-P and GS21
The setting range depends on the drive in which events are stored.

• Drive C: [1] to [1000]
• Other drives: [1] to [2000]

3) [Device Type]
Select the data type of the device to be set.
The following shows selectable items.

• [Bit]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]

[Buffering Data Clear Completion Signal 
Device]

When setting [Buffering Data Clear Trigger Device], set this item. 
Notifies you with a set device that deleting buffering data is complete.
➟6.1.2 How to set devices

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 3)

4)

6)
7)
8)

2)

12)

5)

10)

9)

11)
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• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

4) [Device Setting]
Select whether to set devices sequentially or not.
The following shows selectable items.

• [Continuous]: Set the comment No. of the comment group sequentially.
• [Random]: Set the comment No. of the comment group one by one.
• [Identical]: Select this item when other than [Bit] is selected for [Device Type].

5) [Comment]

6) [Alarm Hierarchy Setting] button
In the [Alarm Hierarchy Setting] dialog, set the levels of alarms in the hierarchy.
For details, refer to the following.

➟(6) [Alarm Hierarchy Setting] dialog
7) [Additional Setting] button

Displays the [Additional Setting] dialog to configure the setting for items displayed in the alarm setting list.
For details, refer to the following.

➟(7) [Additional Setting] dialog
8) [Mail Send Language Setting] button

Displays the [Mail Send Language Setting] dialog to set a language used in a mail to be sent.
For details, refer to the following.

➟(9) [Mail Send Language Setting] dialog
9) [Copy] button

Displays the [Copy Advanced User Alarm Observation] dialog to copy the alarm setting list contents.
For details, refer to the following.

➟(10) [Copy User Alarm Observation] dialog
10) Import button

Imports the alarm observation (user) setting file that has been exported from GT Designer3 to overwrite the settings 
of the [Device] tab.

11) Export button
Saves the settings of the [Device] tab to a Unicode text or CSV file.
You can edit the exported file in spreadsheet software and others.
The edited file can be imported with GT Designer3.
Example) When exporting the settings of the [Device] tab to a CSV file

Item Description

[Basic Alarm Comment]

• [Comment Group No.]: Set the comment group No. to be used for the basic alarm 
comment.

• [Comment No.]: Select the setting method of the comment.
[Continuous]: Set the comment No. of the comment group sequentially.
[Random]: Set the comment No. of the comment group one by one.

[Preview Column No.] Set the column No. of the comment to be previewed.
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12) Alarm setting list
Set devices for alarms and comments displayed at an alarm occurrence.

Item Description

[Monitored alarm No.]

The numbers displayed in the leftmost column of the alarm setting list.
Monitored alarm numbers can be used as a sort criterion for Alarm Display (User).

➟9.1.5 ■4 [Alarm Display(User)] dialog

[Device]
Set devices for alarms.
➟6.1.2 How to set devices

[Alarm Range]

Set a range of device for displaying alarms.
• When the [Device Type] is [Bit]

[ON]: Displays an alarm by rising the bit device (OFF to ON)
[OFF]: Displays an alarm by falling the bit device (ON to OFF)

• When the [Device Type] is other than [Bit]
Click the [Exp.] button to display the [Edit Alarm Range] dialog and set a range of the 
word device value for displaying alarms.

• [Alarm Range]
Select a range expression.
When you select [Other], click the [Exp] button to display the [Edit Range] dialog and set 
the range expression.
➟6.2.2 Setting Trigger Types
9 - 38 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

*1 The following shows examples for displaying comments of the comment group in the basic alarm, the upper 
alarm, the middle alarm, and the detailed screen.

• Register comments to be displayed at an alarm occurrence to the comment group.

[Basic Alarm Comment No.], [Middle 
Comment No.], [Upper Comment No.] *1

Set the comment No. of the comment group for comments to be displayed at an alarm 
occurrence.
Specify the comment No. of the comment group used in the basic alarm, the middle alarm, 
and the upper alarm for one alarm.
To hide the middle alarms and the upper alarms, set [0].

[Detail Display]

Select the display method of the detail display.
• [Not Display]:

The details are not displayed.
• [Comment Window]:

Displays the details in a window for the detail display.
In the comment window, the registered comments are displayed.

• [Base Screen]:
Displays a base screen as the detail display.
Displays the base screen set for the detail No. in the device.

• [Window Screen]:
Displays the window screen (overlap window 1) as the detail display.
Displays the window screen set for the detail No. in the device.

When setting the [Detail Display] for each alarm, set [Comment No.] to [Random] in the 
[Detail Comment] of the [Alarm Hierarchy Setting] dialog.
When [Comment No.] is set to [Continuous], the [Detail Display] of all alarms are set as 
same as the head alarm.*2

➟(6) [Alarm Hierarchy Setting] dialog

[Detail No.] Set a comment number, window screen number, and base screen number of the detail 
display.

[Reset]

Set the reset operation for the alarm.
• [YES]:

Enables the reset operation for the alarm.
The bit device turns off the specified device.
The word device turns the specified device value to the reset value.
Set the reset value after selecting.

• [NO]:
Disables the reset operation for the alarm.
The specified device is not turned off or the device value is not turned to the reset value.

[Level]

Set the level of alarms.
The setting range is [1] to [255].
You can display the alarm with higher level preferentially or display the alarms with specific 
level only.

[Group]

Set the group of alarms.
The setting range is [1] to [255].
You can display the alarms in order of the group or display the alarms with specific group 
only.

[Mail Send]

Set the mail sending method.
• [None]:

No mail is sent.
• [Occur]:

Sends the date of occurrence or comment contents at an alarm occurrence (when a 
specified device condition is satisfied) by mail.

• [Restore]:
Sends the date of restoration or comment contents at an alarm restoration (when a 
specified device condition is not satisfied) by mail.

• [Occur/Restore]:
Sends the date or occurrence or restoration and comment contents at an alarm 
occurrence or alarm restoration by mail.

[Confirmation Device]

Set a bit device to change the status of an alarm to "Checked".

➟6.1.2 How to set devices
When the set device is turned on, the status of the corresponding alarm is changed to 
"Checked".
The GOT monitors the set device in the cycle that is specified with [Watch Cycle].

[Confirmation Notification Device]

Set a bit device to notify that the status of an alarm has been changed to "Checked".

➟6.1.2 How to set devices
When the status of the corresponding alarm is changed to "Checked", the set device turns 
on.
You need to turn off the device after it is turned on.

Item Description
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• Set the registered comments to the user alarm monitoring.

When configuring the following settings to comments displayed at an alarm occurrence, [No Message] is displayed at an alarm 

Comment group No. 1
(For the upper alarms)

Comment group No. 2
(For the middle alarms)

Comment group No. 3
(For the basic alarms)

Comment group No. 4
(For the detail screens)

Register comment groups 
by level in the alarm hierarchy.

1. Set a group No. to be displayed for each level in the hierarchy.

2. Set comments displayed in the basic alarm, the middle alarm, upper alarm, and the detail screen for each alarm.
A comment 
displayed 
in alarm M10
A comment 
displayed 
in alarm M11
A comment 
displayed 
in alarm M12

Set the comment in 
the comment group No. 3.

Set the comment in 
the comment group No. 2.

Set the comment in 
the comment group No. 1.

Set the comment in 
the comment group No. 4.

Example) Comment display when the alarm M10 occurs

Checked

An error has occurred in the power supply unit.

An error has occurred in the control unit.

An error has occurred in the drive module.

Checked

An error occurs in the device A.

An error occurs in the device B.

An error occurs in the device C.

Checked

An error has occurred in line1.

An error has occurred in line2.

Checked

An error has occurred in the power supply unit.

An error has occurred in the control unit.

An error has occurred in the drive module.

Supply oil.

Displays the basic alarm. Displays the middle alarm. Displays the upper alarm. Detail display
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occurrence.
• No comment is set ([0] is specified for the comment No.).
• A comment is not set to the set comment No.

In using hierarchical alarms, if a level in the hierarchy does not need any comment, enter a blank (only space) so as not to display 
[No Message].
Example 1) No comment is specified No.).

Example 2) Blank comment is specified

*2 The following shows the display method of the comment window.

No comment is set.

"No message" 
is displayed.

Displays the upper alarm.Displays the middle alarm.Displays the basic alarm.

Checked

An error has occurred in the power supply unit.

An error has occurred in the control unit.

An error has occurred in the drive module.

Checked

An error occurs in the device A.

No massage

No massage

Checked

An error has occurred in line1.

No massage

No massage

Up Down Up Down Up Down

Set a blank comment (comment No. 2)

Enter a space.

Register a blank comment

Displays the upper alarm.Displays the middle alarm.Displays the basic alarm.

CheckedUp Down

An error has occurred in the power supply unit.

An error has occurred in the control unit.

An error has occurred in the drive module.

CheckedUp Down

An error occurs in the device A.

CheckedUp Down

An error has occurred in line1.

A blank comment 
is displayed.
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Item Specifications

Number of characters that can be displayed in 
a comment window

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 39 characters can be displayed in each row and 11 rows can be displayed. Thus, 
A maximum of 429 characters can be displayed.
Two -byte character forms a row with 19 characters and up to 11 rows, 209 characters 
can be displayed.

• For GT2107-W, GT2105-Q, GT2104-R, and GS21
Up to 161 one-byte characters (7 lines of 23 characters) are displayed.
Up to 77 two-byte characters (7 lines of 11 characters) are displayed.

• GT21-P
Up to 203 one-byte characters (7 lines of 29 characters) are displayed.
Up to 98 two-byte characters (7 lines of 14 characters) are displayed.

Display position of the comment window
A comment window is displayed on the base screen.
The window can be moved and closed in the same way that operates window screens.

Display of comments
Text size is fixed to one time high and one time wide.
Regardless of the settings made when comments are registered, a blink and HQ 
characters are not displayed.

Display of comment rows

From the top left of the comment window, the registered comments are displayed.
When a comment is longer than the display range of the comment window, the comment 
is wrapped around to be displayed.
To display the comment in the center of the comment window, adjust the position of the 
comment by inserting line feeds.

Displays the specified base screens and window screens.Displays the specified comment.

Displaying in a window screen 
(overlap window)

Displaying in a comment window Displaying in a base screen

Check line2.
Check line2.

Alarm history display

Check line2.

Alarm history display

1. Displaying the detail display screen 
by a single touch operation

2. Displaying the detail display screen 
by key inputs of a touch switch

Comment Restored Checked
Line1 error 11:25 10:45
Line2 error 12:28

Error date and time
Jun. 1, 2013 10:25
Jun. 1, 2013 12:05
Jun. 1, 2013 12:35 Line3 error

Comment Restored Checked
Line1 error 11:25 10:45
Line2 error 12:28

Error date and time
Jun. 1, 2013 10:25
Jun. 1, 2013 12:05
Jun. 1, 2013 12:35 Line3 error

Detail display

Running ready
Wait approximately 6 minutes

Running ready
Wait approximately 
6 minutes

Registering comment Displaying comment window
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(3) [File Save] tab

Set the following items to save the alarm histories stored in the buffering area in the data storage.

1) [Save alarm log files]
Writes the user alarm histories stored in the buffering area as alarm log files to the data storage when [Historical] 
or [Cumulative] is selected in [Collection Mode] of the [Basic] tab.
Into data storage, the log file is written as a binary file (*.G2A).

2) [Save Destination]

Item Description

[Drive Name]

Select a destination drive.
The following shows selectable items.
• [A:Standard SD Card]
• [B:USB Drive]
• [C:Built-in Flash Memory]
• [D:Built-in SRAM]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]
[C:Built-in Flash Memory] or [D:Built-in SRAM] is settable only in one user alarm observation 
setting in one project.
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

[Folder Name]

Set the folder name of the destination to save a file.
The default is set to the folder name that is specified with [Package Folder Name] in the [Type 
Setting] dialog.
Alphanumeric characters and following symbols are available for the folder name.
#$%&'()+-.=@[]^_{}~\
For the restrictions on the folder name used with the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
When [Drive Name] is set to [C:Built-in Flash Memory] or [D:Built-in SRAM], the folder name 
specified with [Package Folder Name] in the [Type Setting] dialog is applied.

[File Name]

Set the file name of the destination to save a file.
As the default, AAM***** is set for the file name. (* indicates alarm IDs.)
Alphanumeric characters and following symbols are available for the file name.
#$%&'()+-.=@[]^_{}~
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)

4)
5)
6)

7)
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3) [Store Trigger]

4) [Writing Notification Device]
Set a device which notifies that the alarm log file is in the process of being written.

5) [Writing Error Notification Device]
Set a device which notifies an error when alarm log file writing fails.

➟9.1.2 ■4 (7) Error occurred during the alarm log file saving
6) [Automatically backup at the time of saving]

Saves the alarm log file created immediately before it is saved as a backup file (*.BAK).
If the name of the alarm log file is AAM00001.G2A, the name of the backup file is AAM00001.bak.
The stored backup file is not displayed in the utility of the GOT.

7) [File Convert]
Set the following items to convert files.
To use file conversion, the setting of [Alarm Common Setting] is required.
Click the [Alarm Common Setting] button and set the [Alarm Common Setting] dialog.

Item Description

[Trigger Type]

Select the timing when the user alarm stored in the buffering area is stored to the data 
storage.
The following shows selectable items.
• [Rise]
• [Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [Alarm State Change]
When setting [Sampling], [ON sampling], or [OFF sampling], set a cycle.
The following shows the setting range.
[1] minute to [1440] minutes

[Device]
Set a device used as a store trigger.

➟6.1.2 How to set devices

Item Description

[Conversion Format]

Set the file format applied after the conversion.
• [Unicode Text]:

Saves as a Unicode text file.
• [CSV]:

Saves as a CSV file.

[Add date information to the file name] Date information is added to the name of the alarm log file.

[Specify the date/time format for file output]
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.
➟6.3.2 Date/time format settings

[Save Destination]

Select the save destination folder for a converted file.
• [Same as log file]:

Saves in the destination for the alarm log file.
• [Change]:

Saves in a destination different from one for the alarm log file.
Set [Drive Name] and [Folder Name].
The setting method is the same as that of [Save Destination] for the alarm log file.
[File Name] is the same as that of the alarm log file. The file is saved as (*.TXT) if the 
conversion format is [Unicode Text] and (*.CSV) if [CSV].
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(4) [Extended] tab

Select a device search method for alarms at the sequence program monitor startup and whether to notify alarms to 
Pocket GOT.

1) [Ladder Search Setting]

The settings are not required for GT SoftGOT2000 that does not support the sequence program monitor.
2) [Notify Pocket GOT of the alarm status]

When a user alarm occurs, it is notified to Pocket GOT.
When this item is selected in the user alarm observation setting, notification is enabled for the alarm ID.
In one project, notification is available for up to 40 alarm IDs in ascending order.
Notification will not be available for the 41st and later alarm IDs.
Up to five latest alarms in the history are notified in one alarm ID.
When you select this item, configure the settings in Pocket GOT to obtain alarm information.
For the details, refer to the following manual.

➟Pocket GOT Mobile App Operating Manual

Item Description

[Ladder Search Mode] Select a ladder searching method from [Coil] or [Factor].

[Specify the search file]

Select this item to specify the name of the program file to be searched.
A file whose name is up to 60 characters long can be searched for.
A file whose name includes both two-byte and one-byte characters can also be searched 
for.
A file whose name includes one-byte spaces or any symbol below cannot be searched for.
( " \ / ; : ? < > ¦ + = [ ] . , )

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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(5) [External Output] tab

Set the following items to save the number of user alarms and the occurrences.

1) [History Number Storage]
Select this item to store the number of the user alarm histories in the word device.
All the errors in the status of "Occurred", "Checked", and "Restored" are included in the number of the histories to 
be stored.

➟6.1.2 How to set devices
2) [Generated Number Storage]

Select this item to store the number of the system alarms that are currently occurring in the word device.
➟6.1.2 How to set devices

(6) [Alarm Hierarchy Setting] dialog

1) [Hierarchy]
Select a level to be added in the hierarchy.

2) [Comment Group No.]
Set the comment group No. of the comment.
The set comment group name is displayed.

3) [Comment No.]
Select the setting method of comment No.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

Item Description

[Continuous] Sets the comment No. of the comment group sequentially.

[Random] Sets the comment No. of the comment group one by one.

1) 2) 3)
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(7) [Additional Setting] dialog

1) [Level]
Adds a level setting.

2) [Group]
Adds a group setting.

3) [Mail Send]
Adds a mail send setting.

4) [Mail Send Language Setting] button
Displays the [Mail Send Language Setting] dialog to set the language used in an e-mail to be sent.

➟(9) [Mail Send Language Setting] dialog
5) [Alarm Print]

Adds the alarm print setting.
For information on how to set the alarm print, refer to the following.

➟10.11.3 How to use the report function
6) [Alarm Print Detail Setting] button

Displays the [Alarm Print Detail Setting] dialog to set the alarm details printed on a report.
➟(8) [Alarm Print Detail Setting] dialog

7) [Confirm the occurred alarm]
Adds the setting of a device to change the status of an alarm to "Checked".
Select a device setting method.
The following shows selectable items.

8) [Notify that the alarm is confirmed]
Adds the setting of a device to notify that the status of an alarm has been changed to "Checked".
Select a device setting method.
The following shows selectable items.

Item Description

[Continuous] Sets successive devices starting from a set device.

[Random Set device numbers one by one.

Item Description

[Continuous] Sets successive devices starting from a set device.

[Random Set device numbers one by one.

1)
2)
3)
5)
7)
8)

4)
6)
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(8) [Alarm Print Detail Setting] dialog

1) [Print Target]
Details of an alarm to be printed.
Up to 100 alarms can be output when multiple alarms are checked or reset simultaneously. (Example: All the alarms 
are collectively checked by using the all alarms check operation or the alarm check external control.)
Any files exceeding the limit will be discarded.

2) [Print Item
Set the details of data to be printed.

3) [Basic Alarm Comment Column No.]
Select a method of specifying the column number to print an alarm comment.
The following shows selectable items.

4) [Status Print Language]
Select the language to print the alarm status.
The following shows selectable items.

• [Japanese]
• [English]

Item Description

[Print the information of occurred 
alarms] Prints the details of the alarms in the occurred status.

[Print the information of checked 
alarms]

Prints the details of the alarms in the checked status.
Details of the alarms in the checked status only cannot be printed.
Select [Print the information of occurred alarms] or [Print the information of restored alarms] to enable 
printing of the details of the alarms in the checked status.

[Print the information of restored 
alarms] Prints the details of the alarms in the reset status.

Item Description

[Attribute]

[Occurred/Checked/Restored] Prints the date and time of alarm occurrence, check, or reset.

[Basic Alarm Comment] Prints the date and time on which an alarm occurred or was corrected.

[Status] Prints the status of an alarm.

[Digits]
[Self-adjust] Automatically adjusts the number of digits to be printed according to 

the print contents.

[Fixed] Specify the number of digits to be printed.

[Detail]
Click [...] button to set the date and time format.

➟6.3.2 Date/time format settings

Item Description

[Change with language switching 
device] Specifies the column number according to the language switching device.

[Fixed]
Set the column number to print a comment.
The setting range is [1] to [30].

1)

2)

3)

4)
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(9) [Mail Send Language Setting] dialog

1) [Title]
Select a language.
The following shows selectable items.

• [Japanese]
• [English]

2) [Message]
Input text for the comment.
The setting range is [1] to [30].

(10)[Copy User Alarm Observation] dialog

1) [Source No.]
Set a line number to be copied.

2) [Destination No.]
Set a line number where the copied contents are pasted.

3) [Number of Copy]
Set the number of times the copied contents are pasted.
Pastes the copied contents sequentially for the number of lines set in the [Number of Copy] from the line No. set in the 
[Source No.].

4) [Copy Item]
Select the items to be copied.

1)

2)

Item Description

[Alarm Range] Sets the contents of the [Alarm Range] column to be copied.

[Detailed Alarm Display Type] Sets the contents of the [Detailed Alarm Display Type] column to be copied.

[Detail No.] Sets the contents of the [Detail No.] column to be copied.

[Basic Alarm Comment No.] Sets the contents of the [Basic Alarm Comment No.] column to be copied.

[Middle Comment No.] Sets the contents of the [Middle Comment No.] column to be copied.

[Upper Comment No.] Sets the contents of the [Upper Comment No.] column to be copied.

[Level] Sets the contents of the [Level] column to be copied.

[Group] Sets the contents of the [Group] column to be copied.

[Device Reset] Sets the contents of the [Reset] column to be copied.

[Mail Send] Sets the contents of the [Mail Send] column to be copied.

[Confirmation Device] Sets the contents of the [Confirmation Device] column to be copied.

[Confirmation Notification Device] Sets the contents of the [Confirmation Notification Device] column to be copied.

1)
2)
3)

4)
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■8 [Alarm File Conversion] dialog

A binary file (*.G2A) stored in the data storage with GT Designer3 can be converted into a Unicode text file or CSV file.
Since the file is converted with GT Designer3, converting is processed without any load on the GOT.

Step 1 Store the binary file (*.G2A) in the personal computer.
• Transferring with GT Designer3

Select [Communication] → [Read from GOT...] from the menu to transfer a binary file to the personal 
computer.

• Storing by using the data storage
Save a binary file to the data storage and read the file in the data storage using the personal computer.

Step 2 Select [Tools] → [Resource Data Conversion] → [Alarm File] from the menu.
Step 3 The [Alarm File Conversion] dialog appears.

1) [Source of Conversion]

2) [Destination File]

Item Description

[Type] The conversion source file type.

[Path] Specify a path of the conversion source file.

[Target files in the same path]

Select this item to set all binary files (*.G2A) on the same path to the conversion target. 
A conversion log is created to a destination with the set path automatically. 
You can check the full path of the converted files, the conversion results or the creation 
date of files with the conversion log.

[Project Data (where log file is created)] Select the project data used for generating the alarm log file for the conversion.

Item Description

[Type]

Select a file type of a file to be created after the conversion. 
The following shows selectable items.
• [CSV]
• [Unicode Text]

[Path] A path for a destination where a destination file is saved. 
The same path as the one of the conversion source file is displayed.

[File Conversion Language]

• [Comment Column No. (User Alarm)]:
Select the comment column No. when the conversion source file is a user alarm.

• [Language (System Alarm)]:
Select the language when the conversion source file is a system alarm.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
9 - 50 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

■9 Relevant settings

Set the relevant settings other than the specific settings for the user alarm monitoring as required.
The following shows the functions that are available by the relevant settings.

(1) GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

*1 A signal which notifies the full during the access exists in the user alarm monitoring. The signal differs from that of the Drive 
status notification signal. 
For details, refer to the following.

➟9.1.2 ■4 (8) Difference from the Drive status notification signal (writing device: system signal 2-2)
*2 Reset the Drive A/B File Access Error signal (writing device: System signal 2-2.b7, b8) with the File Access Error Reset 

signal (read device: System signal 1-2.b0).

(2) GOT internal device
➟1.2.7 ■1 (1) GOT internal devices (GB, GD, and GS)

*1 Only when [Save alarm log files] is selected in the [File Save] tab of the [User Alarm Observation], the data is saved. 
When [Save alarm log files] is not selected, the user alarm is not saved.

➟9.1.2 ■7 (3) [File Save] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying the status of the access to the drive *1(Write device: System signal 2-
2.b0, b1) [System Signal 2-2]

Notifying that the free space in the drive is insufficient *1(Write device: System 
signal 2-2.b4, b5) [System Signal 2-2]

Notifying the failure of the access to the drive *1*2(Write device: System signal 2-
2.b7, b8) [System Signal 2-2]

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key codes set to the input keys when the keys are input to ASCII 
input, touch switch, or other objects. (Write device) [Key Code Input]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

Function Setting item

Saving the data in the buffering area to data storage *1 GS520.b0

Changing the character code to Unicode when a binary file is converted to CSV 
format
(Read device)

GS522.b2
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

9 - 51



9.1.3 Collecting alarms by monitoring the system

➟■1 Specifications of the system alarm observation
■2 How to use the system alarm observation
■3 Precautions for drawing
■4 Precautions for use
■5 [System Alarm Observation] dialog
■6 Relevant settings

The system alarm observation logs errors occurred in the GOT, controller, or network as system alarm events in the GOT 
built-in memory.

■1 Specifications of the system alarm observation

(1) Types of the alarms which can be monitored and necessary settings
(a) Alarm type

You can monitor the following alarms with the system alarm observation.
• CPU error

Indicates an error of a controller.
• GOT error

Indicates an error of the GOT.
A GOT Mobile error, which occurs on a GOT Mobile function client, is categorized as a GOT error.

• Network error
Indicates an error of the communication unit mounted on the GOT.

The type of alarms to be monitored is selectable.
The alarm events are displayable by alarm type, enabling you to rapidly grasp the alarm information.

(b) Required settings for using the system alarm
To use the system alarm, select [Use System Alarm] in the [Basic] tab of the [System Alarm Observation] dialog and set 
a monitor target.

➟9.1.3 ■5 [System Alarm Observation] dialog
For system alarm monitors, set the type of the alarms to be collected and the collecting method of the alarms.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

An error occurred
in the system.

Error date 
and time Comment

Jun. 1, 2013 70   The battery voltage 
became lower than the spec.

Jun. 1, 2013 803 The transient 
error has occurred.

Jun. 1, 2013 402 A communication 
timeout has occurred.

Checked

Line No. 1
A 1254

B 348

A 1254

B 348

Buffering area

Stores the alarm data 
in the buffering area.

An alarm occurred!

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 How to use the system alarm observation

(1) Alarm collecting procedure and alarm history collecting method
(a) Alarm collecting procedure

• CPU errors, network errors
CPU errors and network errors are collected in the cycle of 3 seconds in the buffering area in the user area of the 
GOT, regardless of the screen being displayed.
The buffering area stores the collected system alarms as histories temporarily, and displays them on the GOT as 
alarms.

• GOT error
GOT errors are collected in the buffering area in the user area when alarms occur.

• For how to delete the data in the buffering area, refer to the following.
➟9.1.3 ■2 (2) Recovery from alarms

• The data to be stored in the buffering area of the user area differ depending on the history collecting method.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error date and time Comment

Jun. 1, 2013 14:46:49
Communication timeout. 
Confirm communication pat

Jun. 1, 2013 13:30:14 Battery voltage low or 
equipment fault

Buffering area

 User area

Displays the system alarm data collected 
in the buffering area as alarms.

Whether or not the screen is displayed, errors are 
collected in the cycle of 3 seconds in the buffering area.
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(b) Alarm history collecting method
The following shows the alarm history collecting method.

• History mode
Adds the alarm contents to the user area of the GOT for each alarm occurrence.

• Only the current alarm
Displays only the alarm in occurrence, and deletes the display after the alarm restoration.

For the setting of the alarm history collecting method, refer to the following.
➟9.1.3 ■5 [System Alarm Observation] dialog

Depending on the collecting method, the types of information collected differs.
Example) Alarm Display (system)

Displayed 
information

Description

History mode Alarms in the "Occurred" status only

(1) Date of 
occurrence Displays the date and time when an alarm occurs.

(2) Message

Displays an error code and massage when an alarm occurs. 
For error codes and the corrective actions, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
Massages registered in the GOT beforehand are displayed as alarm massages.

(3) Alarm status

Displays the alarm status that is currently displayed.
• Occurred: The alarm has occurred. (The occurrence of the alarm has not been checked.)
• Checked: The occurrence of the alarm has been checked.
• Restored: The monitor target already recovered from the alarm.

(4) Restored Displays the date and time when the monitor target 
recovered from the alarm. -

(5) Checked

Displays the date and time when an alarm occurrence has been checked. 
Check the occurrence of the alarm with a touch switch for the alarm check.

➟9.1.3 ■2 (7) Useful operations and functions

(1) (2) (3) (4) (5)

Jun. 1, 2013 Checked -
Jun. 1, 2013

Jun. 1, 2013 - -
Error date and time Alarm status Restored Checked

16:10
18:30
20:00 402 Communication timeout. Confirm communicat

Comment

70   Battery voltage low or equipment fault
803 Transient error Checked 16:30 16:20

18:50

- -

Restored Checked
402 Communication timeout. 
Confirm communication pathway

Comment

- 19:00

Restored Checked
402 Communication timeout. 
Confirm communication pathway

Comment
Checked

Key code: FFB4h or FFB5h
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(c) Alarm display example
The following shows the examples for displaying alarms with the alarm display (system) for each alarm collecting method.

• Historical
Collects the alarm occurrence status as histories.
The history is added every time an alarm occurs.

402 Communication 
timeout. Confirm 
communication 
pathway or modules.

500 Warning! Built-in 
battery voltage is low.

Recovery 
from the 
alarm

Alarm check 
by a user

Alarm reset 
by a user

An alarm 
occurs.

An alarm 
occurs.

An alarm 
occurs.

11:30
(1)

12:00
(2)

15:30
(3)

18:25
(5)

16:00
(4)

Jun. 1, 2013
Jun. 1, 2013

Jun. 1, 2013
Error date and time

10:25
11:30
18:25 402 Communication timeout. Confirm communic

Comment

402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

16:00 12:00

16:00 12:00

(5) The reset communication 
      timeout occurs again

Jun. 1, 2013
Jun. 1, 2013
Error date and time

10:25
402 Communication timeout. Confirm communic
Comment

500 Warning! Built-in battery voltage is low.

(4) Alarm reset

Jun. 1, 2013
Jun. 1, 2013

Error date and time

10:25
11:30

11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

12:00

(3) Communication timeout restoration

Jun. 1, 2013
Jun. 1, 2013

Error date and time

10:25
11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

12:00

(2) Communication timeout check

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

10:25
11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

Occurred
Occurred

Checked
Occurred

Checked
Occurred

Checked
Occurred

Occurred

Occurred
Checked

(1) Occurrence of a communication timeout

A communication 
timeout has occurred.

The communication timeout error 
has already been checked.

The alarm status of the GOT 
does not turn "Restored".

The alarm status of the 
GOT turns "Restored" and 
the recovery time is displayed.

Displays the alarm 
adding a row newly.

Checked

Key code: FFB4h

The alarm was reset.
Reset

Key code: FFB4h
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• Alarms in the "Occurred" status only
Only the latest GOT error, CPU error, and network error are collected.
The histories of the alarms that have been recovered are not stored.

(2) Recovery from alarms
The following shows the procedure for turning the alarm status of each error to "Restored".

(a) CPU errors
Eliminate all the alarm causes of the CPU error.
The alarm status of the system error caused by the CPU error turns "Restored" by eliminating all the alarm causes.
When the multi-channel function is used, the alarm status of all the channels turns "Restored" by eliminating the alarm 
causes of all the channels.

(b) Network errors
Eliminate all the alarm causes of the network error.
The alarm status of the system error caused by the network error turns "Restored" by eliminating all the alarm causes.

(c) GOT errors
Eliminate all the alarm causes of the GOT error.
Otherwise the same alarm occurs again after the alarm status is turned from "Occurred" to "Restored".
Example) When the alarm of error code 460 occurs and the alarm is reset before the cause is eliminated

Jun. 1, 2013
Jun. 1, 2013
Error date and time

10:25
18:25 402 Communication timeout. Confirm communic

Comment

500 Warning! Built-in battery voltage is low.

(5) The reset communication 
      timeout occurs again

Jun. 1, 2013
Error date and time

10:25 500 Warning! Built-in battery voltage is low.
Comment

(4) Alarm reset

Jun. 1, 2013
Jun. 1, 2013

Error date and time

10:25
11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

12:00

(3) Communication timeout restoration

Jun. 1, 2013
Jun. 1, 2013

Error date and time

10:25
11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

12:00

(2) Communication timeout check

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

Restored CheckedAlarm status

10:25
11:30

Comment
402 Communication timeout. Confirm communic
500 Warning! Built-in battery voltage is low.

Occurred
Occurred

Checked
Occurred

Checked
Occurred

Occurred

Occurred
Occurred

(1) Occurrence of a communication timeout

A communication 
timeout has occurred.

The communication timeout 
error has already been checked.

The alarm status of the GOT 
does not turn "Restored".

After the alarm status turns 
"Restored", the alarm is deleted.

Displays the alarm 
that has occurred.

Checked

Key code: FFB4h

Not collected if only the alarms in 
the "Occurred" status are displayed.
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The alarm status of GOT errors does not turn "Restored" even after the alarm causes are eliminated. To turn the status 
to "Restored", execute any one of the following operations.

• Turning the alarm status of a selected error to "Restored"
Using a touch switch, turn the alarm status of an selected error to "Restored".

➟9.1.3 ■2 (7) Useful operations and functions

• Using the system information, turning the alarm status of all the GOT errors to "Restored"
By turning on the GOT Error Reset signal (System signal 1-1.b13), turn the alarm status of all the GOT errors to 
"Restored".

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

• Using a utility, turning the alarm status of all the GOT errors to "Restored"
Using the alarm display (system) utility, turn the alarm status of all the GOT errors from "Occurred" to "Restored".

➟GOT2000 Series User's Manual (Utility)

Alarm status

10:25
11:30

Comment
803 Transient error
460 Communication unit error

Occurred
Occurred

Jun. 1, 2013
Jun. 1, 2013

Error date and time

The status of the GOT 
error turns "Restored".

After the rest, the same 
alarm occurred again.

Jun. 1, 2013
Jun. 1, 2013

Error date and time

10:25
11:30

Comment
803 Transient error
460 Communication unit error

Alarm status
Occurred
Restored

Jun. 1, 2013
Jun. 1, 2013

Error date and time

11:30
12:00

Comment
460 Communication unit error
803 Transient error

Jun. 1, 2013 10:25 460 Communication unit error

Alarm status
Occurred
Occurred
Restored

Reset Reset the alarm. 
(Turn on the System signal 1-1.b13.)

The date and time of occurrence 
displayed show the date and time 
when the alarm was detected again 
after the reset.

Error 
occurred

Cause 
elimination

Eliminate the cause of the alarm of 
the GOT, a controller, or a network.

Error date 
and time Comment Alarm 

status

Jun. 1, 2013 70   Battery voltage low or 
equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013 402 Communication timeout. 
Confirm communication path

Restored

Restored

Occurred

The alarm status of the GOT error remains "Occurred" 
even if the cause of the alarm is eliminated.

Key code: FFB9h

Reset
Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Occurred402 Communication timeout. Confirm commun

Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Restored402 Communication timeout. Confirm commun

Turn on the System 
signal 1-1.b13.

Reset
Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Occurred402 Communication timeout. Confirm commu

Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Occurred

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Restored402 Communication timeout. Confirm commu
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(3) Deleting alarm data
Alarms in the "Restored" status can be deleted from the history.
To delete alarms, turn the alarm status from "Occurred" to "Restored".

➟9.1.3 ■2 (2) Recovery from alarms
To delete alarm data, perform one of the following operations.

(a) Deleting with a device
Turn on [Buffering Data Clear Trigger Device] set in the [Basic] tab of the [System Alarm Observation] dialog to delete all 
alarm data in the "Restored" status.

(b) Deleting with a touch switch
Use a touch switch to delete one or all alarm data items in the "Restored" status.

(c) Powering off or resetting the GOT
Power off or reset the GOT to delete alarm data.
However, when the alarm data is stored in a data storage, the data is retained even after the GOT is powered off.

➟9.1.3 ■2 (7) Useful operations and functions

(d) Changing the [Controller] setting in the utility
Change the [Controller] setting in [GOT basic set] in the utility to delete all alarm data in the "Restored" status.

(e) Writing/deleting data to/from the GOT
Perform any of the following operations in the [Communicate with GOT] dialog to delete all alarm data in the "Restored" 
status.

• Writing package data
• Deleting an item from the drive information
• Formatting a drive

(4) Power-failure backup of the system alarm data
(a) Overview of the power failure backup

Once the system alarm data are stored in the data storage or the SRAM user area as the alarm log file, the system alarm 
data are held even when the GOT is powered off.
When the alarm log file is stored in the data storage or the SRAM user area when the GOT is powered on, the alarm log 
file is read automatically and the system alarm history before the power-off is recovered.

Turn on the buffering 
data clear trigger device.

Delete
Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Restored

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Restored402 Communication timeout. Confirm communi

Error date and time Comment Alarm status

Jun. 1, 2013 09:10 Occurred803 Transient error

Key code: Delete one event. FFB6h.
                 Delete all events. FFB7h.

Delete
Jun. 1, 2013 10:25 70   Battery voltage low or equipment fault

Jun. 1, 2013 09:10 803 Transient error

Restored

Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 11:30 Restored402 Communication timeout. Confirm communi

Jun. 1, 2013 09:10 803 Transient error Occurred

Error date and time Comment Alarm status

Jun. 1, 2013 10:25 Restored70   Battery voltage low or equipment fault
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(b) Performing the power-failure backup
To hold the data in the data storage, configure the setting in the [File Save] tab of the [System Alarm Observation] dialog, 
and use either of the following methods.

• Storage by the store trigger device
➟9.1.3 ■5 [System Alarm Observation] dialog

• Storage by the touch switch
➟9.1.5 ■2 (11) Touch switches for the alarm display

• Storage by the Buffering And File Access Control: Forcefully Save Buffered Data signal (GS520.b0)
➟12.1 GOT Internal Device

To hold the data in the SRAM user area, configure the setting in the [Basic] tab of the [System Alarm Observation] dialog.
• Saving data to the SRAM user area

➟9.1.3 ■5 [System Alarm Observation] dialog

(c) Information to be stored
The information in the alarm log file to be stored in the data storage and the SRAM user area differ depending on the 
alarm collecting method.

➟9.1.3 ■1 Specifications of the system alarm observation

(d) File name and storage timing
• Saving in data storage

You can set a file name.
➟9.1.3 ■5 [System Alarm Observation] dialog

• Saving data to the SRAM user area
The name of a file to be stored cannot be set.
Alarm data is stored with the timing with which the alarm data is saved in the buffering area.

(e) Available memory capacity
For the memory capacity available for system alarms to be retained when a power failure occurs, refer to the 
specifications of each function.

(f) Backing up the alarm log file stored in the data storage
Select [Automatically backup at the time of saving] in the [File Save] tab of the [System Alarm Observation] dialog to store 
the alarm log file as a backup file when the alarm log file is saved.

(g) Backing up/restoring the data stored in the SRAM user area
Backup or restore the data stored in the SRAM user area by using the [SRAM control] of the utility.

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC
DDDEEEFFF
DDDEEEFFF

Data storage
• The timing with which alarms are saved in the data storage can be set.

(Rise, Fall, Sampling, ON Sampling, or OFF Sampling)

• Data can be saved with touch switch inputs.

Power OFF Power ON
Displays the status that was saved 
before power-off and the current status.

Status that was saved before power-off
Current status

AAABBBCCC
AAABBBCCC

AAABBBCCC
AAABBBCCC
DDDEEEFFF
DDDEEEFFF

SRAM user area

Power OFF Power ON
Displays the status that was saved 
before power-off and the current status.

Status that was saved before power-off
Current status

• Stores the alarm data stored in the buffering area into the SRAM user area.
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For the details of the backup/restore, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(h) Monitoring the writing status
You can monitor an error occurred during the system alarm data writing and a writing error by using a device.

➟9.1.3 ■5 [System Alarm Observation] dialog

(5) Converting alarm log files
Alarm log files generated by system alarms are binary format files (*.G2A).
To display and edit the alarm log files on a personal computer, convert them into Unicode text files or CSV files.
The following shows how to convert the alarm log files.

(a) Creating a Unicode text file or a CSV file with the utility
Convert a binary format file (*.G2A) stored in the data storage into a Unicode text file or a CSV file with the utility.

Step 1 Select a (*.G2A) file in [Alarm information] of the utility and touch the [G2A→TXT] or [G2A→CSV] button.

Step 2 Store the created Unicode text file or CSV file into a personal computer by either of the following methods.
• Transferring with GT Designer3

Reads resource data from the GOT.

Error date and time Comment

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Write operation 
in progress               :
Write operation error: Save

The status of write operations can be monitored.

Write
9 - 60 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

• Storing by using the data storage
Stores the alarm log file to the data storage and reads the alarm log file from the data storage.

Step 3 Display or edit the converted Unicode text file or the CSV file on a personal computer.
• For the operations of the utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)
• To read the resource data from the GOT, refer to the following.

➟4.3.2 ■3 Reading the data from the GOT

(b) Converting a Unicode text file or a CSV file with the device
Turning on a specified device converts a binary format file (*.G2A) stored in the data storage into a Unicode text file or a 
CSV file.

Step 1 Configure the setting for control the alarm log file conversion with the device in the [Alarm Common Setting] 
dialog.

Step 2 Configure the setting for storing the alarm log file stored in the buffering area to the data storage in the [File 
Save] tab of the [System Alarm Observation] dialog.

Error date and time Comment

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Alarm log 
file

Alarm log 
file

Transfer with GT Designer3.

Error date and time Comment

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Alarm log 
file

Alarm log 
file

Use the data storage.
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• For how to configure the setting in the [Alarm Common Setting] dialog, refer to the following.
➟9.1.2 ■5 [Alarm Common Setting] dialog

• For the [File Save] tab setting of the [System Alarm Observation] dialog, refer to the following.
➟9.1.3 ■5 (2) [File Save] tab

• Precautions on converting files by using external control devices
Before converting the alarm log files, store 0 to the device set in [Alarm ID Device] in [Alarm Common 
Setting] dialog.
Always turn off the conversion trigger device after the alarm log file conversion.
When the alarm log file conversion is completed, the conversion notification device does not turn off 
when the conversion trigger device is on.

(6) Configurations of a Unicode text file and a CSV file

No. Description

1) An alarm collecting method.

2) An alarm ID. For system alarms, this item is fixed to 0.

3) An alarm name. For system alarms, this item is left blank.

4) The number of data points.

5) The basic comment group No. For system alarms, this item is fixed to 0.

6) The middle comment group No. For system alarms, this item is fixed to 0.

7) The upper comment group No. For system alarms, this item is fixed to 0.

8) The detailed comment group No. For system alarms, this item is fixed to 0.

9) The number of the alarm histories.

10) The number of unrestored alarms.

11) The number of unchecked alarms.

1)
2)

3)
4)

5)
6)

7)
8)

9)
10)

11)
12)

13)
14)

15) 16) 18) 21) 22) 23) 24) 25) 26)20)19)17) 27) 28)
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(7) Useful operations and functions
(a) When the buffering area is full

You can set a device for executing a notification when the number of alarms reaches to the [Stored Number] set in the 
[Basic] tab of the [System Alarm Observation] dialog.

• Confirming the number of the alarm histories and the alarms
You can confirm the number of the alarm histories by storing the histories stored in the buffering area temporarily to 
a device.
The number of the system alarms that are currently occurring can be confirmed as well.

• When the buffering area is full
You can set a device for notifying the full of the buffering area.
To execute the notification before the buffer area becomes full, set the [Full Notification Signal Device] in the [Basic] 
tab of the [System Alarm Observation] dialog.
Select the operation when the buffering area is full in the [Action When Buffer is Full] in the [Basic] tab of the [System 
Alarm Observation] dialog.

12) The order of the dates.

13) The difference between the Greenwich Mean Time and "Occurred"/"Restored"/"Checked".

14) The order of the output time.

15) The error No..

16) System alarm messages.

17) The alarm status. (O: Alarm has been occurring, but has not been confirmed, OC: Alarm has been occurring, and has been confirmed, 
R: Alarm has been restored, but has not been confirmed, RC: Alarm has been restored, and has been confirmed)

18) The date and time when an alarm occurs.

19) The date and time when an alarm has restored.

20) The date and time when an alarm occurrence has been checked.

21) CH No. (CH1 to CH4)

22) Network No., station No., and module No.

23) Device name.

24)
The screen type. (BASE: Base screen, OVL1 to OVL5: Overlap window 1 to 5, SPI1 to SPI2: Superimpose window 1 to 2, DLG: Dialog 
window, PNL: Operation panel, KEY: Key window, RPT: Report screen, MBL-BASE: Base screen (GOT Mobile), MBL-OVL1 to OVL2: 
Overlap window 1 to 2 (GOT Mobile), MBL-SPI1 to SPI2: Superimpose window 1 to 2 (GOT Mobile))

25) Definition Screen No. (B: Base screen, W: Window screen, R: Report screen, MB: Mobile screen)

26) Object ID.

27) Function name.

28) Drive Name. (A, B, E, F, G)

No. Description

Number of 
histories      : Full:
Number of 
occurrences:

1254
2

Error date and time Comment

Jun. 1, 2013 13:30:14
70   The battery voltage became lower 
than the spec.

Jun. 1, 2013 14:46:49 402 A communication timeout has occurred.

Check the number 
of alarm histories 
and the occurrences.

Number of 
histories      : Full:
Number of 
occurrences:

1254
2

Error date and time Comment

Jun. 1, 2013 13:30:14
70   The battery voltage became lower 
than the spec.

Jun. 1, 2013 14:46:49 402 A communication timeout has occurred.

Full notification
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• Size of the buffering
The size of the buffering area to be used for the system alarm varies depending on the setting.
Increasing the size of the buffering decreases the user area of the GOT. Adjust the size of the buffering according to 
the user area capacity.
Setting items for the size of the buffering area

The size of the buffering area required for the set system alarm list can be confirmed in the [Basic] tab of the [System 
Alarm Observation] dialog.
For the details of the buffering area, refer to the following.

➟9.1.3 ■2 (1) Alarm collecting procedure and alarm history collecting method
For how to configure the setting in the [User Alarm Observation] dialog, refer to the following.

➟9.1.3 ■5 [System Alarm Observation] dialog

(b) Corrective actions on the cause of the alarm of each type and error codes
For details, refer to the following.

➟3.8.1 Error messages (GOT2000 Series simulator)

■3 Precautions for drawing

(1) Setting for saving system alarm data to data storage
To place a button for storing the system alarm data, configure either of the following settings.

• Set the store trigger devices in the [File Save] tab of the [System Alarm Observation] dialog and store the system 
alarm data.

➟9.1.3 ■5 [System Alarm Observation] dialog
• Place a touch switch for the alarm display (system) on the screen where the alarm display (system) is set and store 

the system alarm data.
➟9.1.3 ■2 (7) Useful operations and functions

(2) Available file size
Data storage must have larger capacity than the size of the file to be stored.
For the file size, refer to the following.

➟9.1.3 ■1 Specifications of the system alarm observation

(3) Changing the setting for recording the label or tag name at an alarm occurrence
On the [Basic] tab in the [System Alarm Observation] dialog, changing the setting of [Record label/tag name at the time 
of alarm generation] affects the already recorded label and tag names.
For the setting details and the labels and tags to be recorded, refer to the following.

➟9.1.3 ■5 (1) [Basic] tab
• When clearing this item after recording

The already recorded label and tag names are discarded.
• When selecting this item after recording

For the already collected system alarms, the label and tag names remain unrecorded.

(4) Changing the number of characters of a label or tag name to be recorded at an alarm occurrence
On the [Basic] tab in the [System Alarm Observation] dialog, changing the setting of [Number of characters to be 
recorded] affects the already recorded label and tag names.
For the setting details and the labels and tags to be recorded, refer to the following.

➟9.1.3 ■5 (1) [Basic] tab
• When decreasing the number of characters

Of an already recorded label or tag name, the characters up to the newly-specified number of characters remain and 
the rest is discarded.

• When increasing the number of characters
The already recorded label and tag names are retained.

Alarm collecting method Setting for the size of the buffering area

History mode • Number of alarm histories to be stored ([Stored Number] in the [Basic] tab of the [System Alarm Observation] 
dialog)

Alarms in the "Occurred" 
status only -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Precautions for use

(1) Controllers for which system alarms are not displayed in the GOT
The CPU errors which occur in the following controllers cannot be displayed on the GOT system alarm display (system).
Check the errors with the software for the controllers.

• SIEMENS PLC CPU
• AZBIL controller
• RKC temperature controller
• Inverter

(2) Resetting alarms
The alarm status of GOT errors does not turn "Restored" even if the alarm cause of the GOT errors is eliminated.

For details, refer to the following.
➟9.1.3 ■2 (2) Recovery from alarms

(3) Recovering from network errors and deleting the errors
The alarm status of network errors that occur in the CC-Link communication unit and MELSECNET/H communication 
unit does not turn "Restored" even if the cause of the alarms is eliminated until the GOT is powered off or reset.
For turning the alarm status to "Restored" and deleting the alarms, refer to the followings.

➟9.1.3 ■2 (2) Recovery from alarms

(4) Display of system alarms occurring in multiple channels
If system alarms occur in multiple channels simultaneously, the alarm occurring in the highest numbered channel is 
displayed.

(5) When the same data are stored in data storage

The data in the data storage are overwritten. To reserve the data, move the data in the data storage to a personal 
computer with either of following methods.

• Reading resource data with GT Designer3
➟4.3.2 ■3 Reading the data from the GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error 
occurred

Cause 
elimination

Eliminate the cause of the alarm 
of the GOT, a controller, or a network.

Error date and time Comment Alarm status

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Restored

Restored

Occurred

The alarm status of the GOT error remains "Occurred" 
even if the cause of the alarm is eliminated.

Error date and time Comment

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Save

AAM00000.G2A

Save

AAM00000.G2A

Overwritten!

Touch!
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• Reading a CSV file stored in the data storage with a personal computer

(6) Alarm monitoring during the alarm log file saving
While alarm log files are saved in the data storage, the system alarm monitoring processing is interrupted.
System alarms occurred or recovered during the storing are not displayed.

(7) Storage by the Buffering And File Access Control: Forcefully Save Buffered Data signal (GS520.b0)
It may take minutes for an alarm log file to be saved in data storage because the data of all the target system alarms for 
the alarm log file is saved.
To prevent the monitoring from stopping for a long time, save the alarm log files in units of objects.

• Setting the store trigger for each system alarm observation setting
• Setting the touch switch (key code: FFBBh) for each alarm display (system)

(8) Precautions for removing an SD card
When you open the SD card cover or turn off the SD card access switch, the files are saved automatically.
Before removing the SD card, make sure that the file saving is complete by checking one of the following conditions.

• The Drive Status Notification signal (system signal 2-2.b0, b1) is turned off.
• The SD card access LED is turned off.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])
Storing may take longer because all the user alarms and system alarms for saving the alarm log files are stored.

(9) Restoring the alarm histories when powering-off to on the GOT
When the alarm log file in the data storage is not created in the project in the GOT, the file cannot be read from the GOT.
In this case, an alarm occurs or a device turns on.

• A system alarm 525 occurs.
• The [Writing Error Notification Device] set in the [File Save] tab of the [System Alarm Observation] dialog turns on.

(10)Collecting alarms when the buffering area is full
The operation when the buffering area is full is either of the followings according to the [Action When Buffer is Full] in the 
[Basic] tab of the [System Alarm Observation] dialog.

• Deleting recovered system alarms and adding a new system alarm
• The system alarms are not collected.

To prevent the operations above, set the [Full Notification Signal Device] in the [Basic] tab of the [System Alarm 
Observation] dialog and delete the recovered alarm when the device turns on.

➟9.1.3 ■5 [System Alarm Observation] dialog

(11)Error occurred during the alarm log file saving
When an error occurs during the alarm log file saving, the [Writing Error Notification Device] set in the [File Save] tab of 
the [System Alarm Observation] dialog turns on.
If the Writing Error Notification device turns on, check that the following conditions are satisfied.

• The SD card cover of the GOT is closed.
• The SD card access switch of the GOT is turned on.
• The data storage works normally.

The user needs to turn off this device.

Error date and time Comment

Jun. 1, 2013 70   Battery voltage low or equipment fault

Jun. 1, 2013 803 Transient error

Jun. 1, 2013
402 Communication timeout. Confirm 
communication pathway or modules.

Save

Saving...

Buffering area

 User area

While the files are saved 
in the data storage, the monitoring 
processing is interrupted!
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(12)Difference from the Drive status notification signal (writing device: system signal 2-2)
The full notification, writing notification and a writing error can be notified by the Drive status notification signal as well, 
and the operations differ from the devices set in the system alarm monitoring.

(13)Character code and conversion destination file
If an alarm log file contains any character other than ASCII and Shift JIS characters, convert the file as shown below.

• Convert the file to Unicode text format.
• Turn on the Character Code for CSV Conversion signal (GS522.b2), and convert the file to CSV format.

(14)System language applied at the conversion of the system alarm files
When [System Language Switching Operation] is set for [System Alarm] of [File Conversion Language] in the [Alarm 
Common Setting] dialog, system alarm files are not converted in the language specified in the system language switching 
device.
A file is converted in the system language set in the utility.

(15)Alarm log file conversion by utility
When converting an alarm log file (*G2A) into a CSV file or a Unicode text file with a utility, execute a conversion by each 
file.
Even if multiple files are selected at once, they cannot be converted.

(16)Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(17)To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

Item
Operation (difference)

User alarm observation Drive status notification signal

Difference between [Full Notification Signal 
Device] set for system alarm monitors and the 
Drive status notification signal (System signal 
2-2.b4, b5)

Turns on when the number of log files reaches 
the [Stored Number] set in the [Basic] tab 
(when the buffering area reserved for the 
system alarms is full).

Turns on when the data storage is full.

Difference between [Writing Notification 
Device] set for system alarm monitors and the 
Drive status notification signal (System signal 
2-2.b0, b1)

Turns on while the system alarm data are 
written to the data storage.

Turns on while the data are written to the data 
storage (turns on while data other than the 
system alarm are written).

Difference between [Writing Error Notification 
Device] set for system alarm monitors and the 
Drive status notification signal (System signal 
2-2.b7, b8)

• Turns on when an error occurs at the 
accessing to the alarm log file in the data 
storage (when the alarm log file in the data 
storage is not created in the project in the 
GOT).

• Turns on when the data storage cannot be 
accessed (e.g. when a data storage is not 
installed or the SD card cover is open).

Turns on when the data storage cannot be 
accessed (e.g. when a data storage is not 
installed or the SD card cover is open).
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■5 [System Alarm Observation] dialog

Step 1 Select [Alarm] → [System Alarm Observation] from the project tree.
Step 2 Double-click the [System Alarm Observation] to display the [System Alarm Observation] dialog.

➟(1) [Basic] tab
(2) [File Save] tab
(3) [External Output] tab

(1) [Basic] tab

Set the type of the alarm to be monitored, alarm history collecting method and the buffering that stores the alarm history.

1) [Use system alarm]
Set whether to enable or disable the system alarm function.
To pop up an alarm message, configure the following settings additionally.

• Alarm popup display settings
➟9.1.4 ■4 [Alarm Popup Display] dialog

• Setting of the screen where an alarm message pops up
➟2.7.1 ■1 [Basic] tab

10.19.7 ■1 [Basic] tab
2) [Target]

Select the system alarm to be monitored.
The following shows selectable items.

• [CPU Error]
• [GOT Error]
• [Network Error]

3) [Include errors occurred in clients connected to the server of GOT Mobile function]
Available to GT27, GT25, GT SoftGOT2000, and GS25.
This item is settable only when [Target] is set to [GOT Error].
Monitors errors of a GOT Mobile function client (GOT Mobile errors).

4) [Get detailed alarm information]
Makes it easy to identify where the alarm has occurred by obtaining the detail information of the system alarm.
After a system alarm has occurred, when another system alarm with the same error code occurs, if their error 
factors differ, the alarms are handled as different alarms.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

6)

3)

4)

2)

5)
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The setting determines the information to be obtained.
• Not selected:

Error code, and the date and time of occurrence/restoration/check
• Selected:

Error code, date and time of occurrence/restoration/check, channel No., network No., station No., CPU No., 
device, screen No., definition screen No. (the number of the screen on which an object having an error is placed 
when the set overlay screen function is used), object ID, function name, and drive name

The information obtained varies according to each system alarm.

5) [Collection Mode]
Select a system alarm collecting method.

• [Historical]:
Collects the system alarm occurrence status as histories.
The history is added every time a system alarm occurs.

• [Only the current alarm]:
Collects only the latest CPU error, GOT error, and network error.
System alarms which obtained the Restored" status in the GOT are deleted.

Item Description

[Record label/tag name at the 
time of alarm generation]

Records the label or tag name and the assigned device when a system alarm occurs.
The following shows the labels and tags to be recorded.
• Global label
• OMRON NJ/NX tag
• AB native tag
Even if you change the label or tag set for an object or others after the system alarm collection, you can 
check the label or tag name as of the system alarm collection.
Specify the number of characters of a label or tag name to be recorded with [Number of characters to be 
recorded].
The more the numbers of recorded characters and stored items, the larger the used area of the operation 
memory (RAM).
The following shows the operation when this item is selected.
Example) When the global label name set for the numerical input is changed after system alarm 
collection

Even if this item is not selected, the label or tag name appears on the alarm display or others.
The number of characters is unlimited.
However, if you change a label or tag, the label or tag name as of the system alarm collection does not 
appear.
The symbol (::) indicating a label or tag and the characters indicating the offset setting are displayed.
When an alarm log file is converted to a CSV file or Unicode text file, the label and tag names are not 
output.

[Number of characters to be 
recorded]

Specify the number of characters of a label or tag name to be recorded.
The characters up to the set number of characters are recorded, and the rest is unrecorded.
The setting range is [10] to [300].
The more the number of characters, the larger the used area of the operation memory (RAM) and the 
size of the alarm log file.

A system alarm occurs
 in the numerical input.

The detailed information about the occurred 
system alarm is obtained, and the global label The global label name recorded at 

the alarm occurrence is retained.

Changing the project setting

::LABEL_FOR_LINE_A ::LABEL_FOR_LINE_A

With the change of the global label name, 
change the global label set for the numerical input.

::LABEL_FOR_LINE_A ::LABEL_FOR_LINE_B

name is also recorded.
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6) [Buffering]
Set the buffering that stores collected system alarms.

(2) [File Save] tab

Set the following items to save the alarm histories stored in the buffering area in the data storage.

Item Description

[Retain data in the embedded memory in GOT 
even when the power goes off (The battery 
will be required)]

Saves alarm data in the buffering area in the SRAM user area.
➟9.1.1 ■2 (3) (h) Storing the alarm data (power failure backup)

[Stored Number]

Set this item when setting [Collection Mode] to [Historical]. 
Set the number of the system alarms to be stored. 
The setting range is [512] to [32767]. 
The size of the buffering increases as the number of the alarms to be stored increases.

[Action When Buffer is Full]

Set this item when setting [Collection Mode] to [Historical]. 
Select the operation performed when the number of the system alarms stored in the 
buffering area reaches [Stored Number].
• [Delete old data]:

Among the system alarms in the "Restored" status, deletes the system alarm with the 
oldest date and time of recovery and collects a new system alarm.

• [Add no item]:
Stops collecting system alarms even when new ones occur.

[Full Notification Signal Device]

Set this item when setting [Collection Mode] to [Historical]. 
A set device notifies you that the number of system alarm histories which can be stored in 
the remaining space in the buffering becomes the same as [Notification Number] or 
smaller.
➟6.1.2 How to set devices

[Notification Number]

When setting [Full Notification Signal Device], set this item. 
Set the number of the remaining system alarm histories with which [Full Notification Signal 
Device] notifies. 
The setting range is [0] to [255].
• Setting example

When the [Stored Number] is set to 1000, the [Notification Number] is set to 10
The [Full Notification Signal Device] turns on when the number of stored system alarm 
histories becomes 990 because the number of storable system alarm histories becomes 
10.

[Buffering Data Clear Trigger Device]
Deletes with a set device the system alarms which the monitor targets recovered from and 
are stored in the buffering area.
➟6.1.2 How to set devices

[Buffering Data Clear Completion Signal 
Device]

When setting [Buffering Data Clear Trigger Device], set this item. 
Notifies you with a set device that deleting buffering data is complete.
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)

4)
5)
6)

7)
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1) [Save alarm log files]
When [Historical] is selected for [Collection Mode] in the [Basic] tab, writes the system alarm histories stored in the 
buffering area in data storage as an alarm log file.
Into data storage, the log file is written as a binary file (*.G2A).

2) [Save Destination]

3) [Store Trigger]

4) [Writing Notification Device]
Set a device which notifies that the alarm log file is in the process of being written.

5) [Writing Error Notification Device]
Set a device which notifies an error when alarm log file writing fails.

➟9.1.3 ■4 (11) Error occurred during the alarm log file saving
6) [Automatically backup at the time of saving]

Saves the alarm log file created immediately before it is saved as a backup file (*.BAK).
If the name of the alarm log file is AAM00000.G2A, the name of the backup file is AAM00000.bak.
The stored backup file is not displayed in the utility of the GOT.

7) [File Convert]
Set the following items to convert files.
To use file conversion, the setting of [Alarm Common Setting] is required.

Item Description

[Drive Name]

Select a destination drive.
The following shows selectable items.
• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [X:Current Drive]
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

[Folder Name]

Set the folder name of the destination to save a file. 
The default is set to the folder name that is specified with [Package Folder Name] in the 
[Type Setting] dialog. 
Alphanumeric characters and following symbols are available for the folder name. 
#$%&'()+-.=@[]^_{}~\ 
For the restrictions on the folder name used with the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

[File Name]

Set the file name of the destination to save a file. 
The default is set to AAM00000. 
Alphanumeric characters and following symbols are available for the file name. 
#$%&'()+-.=@[]^_{}~
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

Item Description

[Trigger Type]

Select the timing with which system alarms stored in the buffering area are stored into the 
data storage. 
The following shows selectable items.
• [Rise]
• [Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [Alarm State Change]
When setting [Sampling], [ON sampling], or [OFF sampling], set a cycle. 
The following shows the setting range. 
[1] minute to [1440] minutes

[Device]
Set a device used as a store trigger.

➟6.1.2 How to set devices
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Click the [Alarm Common Setting] button and set the [Alarm Common Setting] dialog.

(3) [External Output] tab

Set the following items to save the number of system alarms and the occurrences.

1) [History Number Storage]
Stores the number of system alarm histories in a set word device.
All the errors in the status of "Occurred", "Checked", and "Restored" are included in the number of the histories to 
be stored.

➟6.1.2 How to set devices
2) [Generated Number Storage]

Stores the number of the system alarms in the "Occurred" status in a set word device.
➟6.1.2 How to set devices

Item Description

[Conversion Format]

Set the file format applied after the conversion.
• [Unicode Text]:

Saves as a Unicode text file.
• [CSV]:

Saves as a CSV file.

[Add date information to the file name] Date information is added to the name of the alarm log file.

[Specify the date/time format for file output]
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings

[Save Destination]

Select the save destination folder for a converted file.
• [Same as log file]:

Saves in the destination for the alarm log file.
• [Change]:

Saves in a destination different from one for the alarm log file.
Set [Drive Name] and [Folder Name].
The setting method is the same as that of [Save Destination] for the alarm log file.
[File Name] is the same as that of the alarm log file. The file is saved as (*.TXT) if the 
conversion format is [Unicode Text] and (*.CSV) if [CSV].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
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■6 Relevant settings

Set the relevant settings other than the specific settings for the system alarm monitor as required.
The following shows the functions that are available by the relevant settings.

(1) GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

*1 A signal which notifies the full during the access exists in the user alarm monitoring. The signal differs from that of the Drive 
status notification signal. 
For details, refer to the following.

➟9.1.2 ■4 (8) Difference from the Drive status notification signal (writing device: system signal 2-2)
*2 Reset the Drive A/B File Access Error signal (writing device: System signal 2-2.b7, b8) with the File Access Error Reset 

signal (read device: System signal 1-2.b0).

(2) GOT internal device
➟1.2.7 ■1 (1) GOT internal devices (GB, GD, and GS)

*1 Only when [Save alarm log files] is selected in the [File Save] tab of the [System Alarm Observation] dialog, the data is 
saved.

➟9.1.3 ■5 (2) [File Save] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Resetting system alarms and system information (GOT error code, GOT Error 
Detection) (Read device: System signal 1-1.b13) [System Signal 1-1]

Notifying the status of the access to the drive *1(Write device: System signal 2-
2.b0, b1) [System Signal 2-2]

Notifying that the free space in the drive is insufficient *1(Write device: System 
signal 2-2.b4, b5) [System Signal 2-2]

Notifying the failure of the access to the drive *1*2(Write device: System signal 2-
2.b7, b8) [System Signal 2-2]

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Notifying the key codes set to the input keys when the keys are input to ASCII 
input, touch switch, or other objects. (Write device) [Key Code Input]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

Function Setting item

Saving the data in the buffering area to data storage *1 GS520.b0

Changing the character code to Unicode when a binary file is converted to CSV 
format
(Read device)

GS522.b2

Storing the channel No. that has been assigned to the channel where a system 
alarm (GOT error) occurs 
(Write device)

GS262

Storing the channel No. that has been assigned to the channel where a system 
alarm (CPU error) occurs 
(Write device)

GS263

Storing the channel No. that has been assigned to the channel where a system 
alarm (network error) occurs (Write device) GS264
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9.1.4 Enabling the popup display for when an alarm occurs

➟■1 Specifications of the alarm popup display
■2 How to use the alarm popup display
■3 Precautions
■4 [Alarm Popup Display] dialog
■5 Relevant settings

In the alarm popup display, the GOT displays alarms whether or not the target object for the alarm popup display is 
placed.
Even a long comment can be displayed in the alarm popup display by scrolling across the screen from right to left.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Detail

Line No. 1
A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

An alarm 
occurred! Jun. 1, 2013 10:30 Temperature

Displays the alarm 
with a popup display.

Detail

A 1254

B 348

A 1254

B 348

10:30 70   The battery voltage be

Detail

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 70 The battery voltage became lower t

Displays the alarm 
with a popup display. Scrolls a long comment.
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■1 Specifications of the alarm popup display

(1) Types of alarms which can be displayed and necessary settings
(a) Alarm type

User alarms and system alarms can be displayed in the alarm popup display.
• Setting the alarm popup display

Set the alarms to be displayed in the alarm popup display.
➟9.1.4 ■4 [Alarm Popup Display] dialog

• Auxiliary settings for each screen
For each base screen and mobile screen, set whether to display the alarm popup display, and set the position of the 
alarm popup display.
Set the alarm popup display in the [Screen Property] dialog.
For details, refer to the following.

➟2.7.1 ■1 [Basic] tab
　 10.19.7 ■1 [Basic] tab

• When the display position overlaps with other objects
Objects hidden under the alarm popup display are not operable.

• Switching the display position with touch operations
The position of the alarm popup display can be switched with touch operations.
For details, refer to the following.

➟9.1.4 ■2 (3) Useful operations and functions

(b) Necessary settings for using the alarm popup display
Prior to using the alarm popup display, set the alarm to be displayed with the alarm monitor.

• Displaying user alarms
Select [Popup Display] in the [Basic] tab in the [User Alarm Observation] dialog.
When user alarms with multiple alarm ID numbers are displayed, whether to display the popup display or not can be 
selected.

➟9.1.2 ■7 (1) [Basic] tab
Additionally, by using a device, only one alarm ID number can be displayed.

➟9.1.4 ■2 (3) Useful operations and functions
• Displaying system alarms

GT21 and GS21 do not support the system alarm function.
Select [Target] in the [Basic] tab in the [User Alarm Observation] dialog.
The selected system alarm is displayed in the popup display.

➟9.1.3 ■5 (1) [Basic] tab

■2 How to use the alarm popup display

(1) Alarms to be displayed in the popup display
In the alarm popup display, the GOT displays alarms in the "Occurred" or "Checked" status.
When the alarm status becomes "Restored" (including already checked alarms which the monitor targets recovered 
from), the display is hidden.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Selecting the display method
(a) Fixed

The comments to be displayed at the occurrence of an alarm are not scrolled in the display.
When multiple alarms occur, the alarms are displayed by automatically switching the display.

• When multiple alarms occur
For the details of the order in which alarms are displayed, refer to the following.

➟9.1.4 ■3 Precautions
• When setting a comment using multiple rows

Only the part in the first row is displayed.
The parts in the second and the following successive rows cannot be displayed.

(b) Flow
Comments displayed when alarms occur are displayed by scrolling from right to left.
When multiple alarms occur, the alarms are displayed in order.

• When multiple alarms occur
For the details of the order in which alarms are displayed, refer to the following.

➟9.1.4 ■3 Precautions
• When setting a comment using multiple rows

After the part of the comment in the first row is displayed, the parts in the second and the following successive rows 

Restored
A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Error date and time Comment Alarm status

Jun. 1, 2013 10:30 Temperature anomaly Occurred

Alarm status

A 1254

B 348

A 1254

B 348

Error date and time Comment Alarm status

Jun. 1, 2013 10:30 Temperature anomaly Restored

Does not display the alarm the monitor 
target has already recovered from.

Alarm status

A 1254

B 348

A 1254

B 348

When a temperature anomaly and the fuse error occur

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly Jun. 1, 2013 09:45 Fuse error

Displays multiple alarms by switching the display.

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

A 1254

B 348

A 1254

B 348

When a temperature anomaly and the fuse error occur

Jun. 1, 2013 09:45 Fuse error

Displays alarms that have occurred 
by scrolling from right to left.

A 1254

B 348

A 1254

B 348

09:45 Fuse error
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are displayed by scrolling.

(3) Useful operations and functions
(a) Operations performed when the popup display section is directly touched

• Screen Switching
The display can be switched to the base screen with a specified No. or overlap window 1.
The popup display can be used in a manner that displays an alarm processing screen with detailed information when 
the popup display section is touched.

➟9.1.4 ■4 [Alarm Popup Display] dialog

• Switching the levels in the hierarchy of comments/Detail display
When user alarms are displayed in the popup, the target level for the display in the hierarchy of comments can be 
switched.

➟9.1.4 ■4 [Alarm Popup Display] dialog

• Levels in the hierarchy which can be switched with touch operations
Touch operations can switch only to lower levels in the hierarchy.
To switch to an upper level in the hierarchy, set [Hierarchy] of [Switching Device] in the [Extended] tab in the [Alarm 
Popup Display] dialog. Then, store the value for the target level in a set device.

➟9.1.4 ■4 [Alarm Popup Display] dialog
• Difference in the display range between the methods of switching levels in the hierarchy

Depending on the method of switching levels in the hierarchy, touch operations or the switching device, the display 
range is different.
For details, refer to the following.

➟9.1.4 ■2 (3) (b) Switching the levels in the alarm hierarchy (for alarm display (user) only)
• Switching the display position

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Displays the base screen of 
a specified No. or overlap window 1.

Error date and time Comment

Jun. 1, 2013 09:45 Fuse error

Jun. 1, 2013 08:15 Oil error

Jun. 1, 2013 10:30 Temperature anomaly

Touch

Alarm detail display/Processing screen

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

-Line abnormal stop -An error has occurred in the power supply unit. Jun. 1, 2013 10:30 Temperature anomaly

Touch Touch Touch

Switches
from 
the upper
to the middle.

Switches
from 
the middle 
to the basic.

Displays the upper alarm. Displays the middle alarm. Displays the basic alarm.

Jun. 1, 2013 10:30 Temperature anomaly

Displays the basic alarm.

Switches from
the basic to the
detail display.

A temperature anomaly

has occurred in the power 

supply unit. 

Check the temperature.
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The display position can be switched with touch operations. Doing so, you can display objects hidden under the alarm 
popup display.
Set [Display Position Switching] in the [Basic] tab in the [Alarm Popup Display] dialog.

Touch the left end of the alarm popup display area to switch the display position. The position changes in the screen 
at every touch. The switching order of the position is upper-center-lower.
The area where touch operations are enabled is within 16 dots from the left end of the display area.

If screen switching is performed while the popup display is displayed, the popup display is displayed where it was 
before the switch.

The display position set in the [Screen Property] dialog is enabled the next time the popup display is displayed.

(b) Switching the levels in the alarm hierarchy (for alarm display (user) only)
In the alarm popup display, the levels of the alarm hierarchy are switched with either of the following methods. However, 
the display range differs depending on the switching method.
The following system examples show differences in display ranges according to the switching methods.

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Jun. 1, 2013 10:30 Temperature anomaly

Jun. 1, 2013 10:30 Temperature anomaly

Touch the left end
of the display area.

Touch the left end
of the display area.

Touch the left end
of the display area.

Switches the
display position.

Switches the
display position.

Displays in the lowermost 
part of the screen.

Displays in the uppermost 
part of the screen.

Switches the display position.

Displays in the center of screen.

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Meshes 
on the 
GOT 
screen

Left end 16 dots

A 1254

B 348

A 1254

B 348

Screen
switching

Displays on the previous position 
regardless of the display position setting.

Line A status

Jun. 1, 2013 10:30 Temperature anomalyJun. 1, 2013 10:30 Temperature anomaly
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• When switching the display by directly touching the popup display section
When an alarm is touched, alarms at levels in the hierarchy lower than that of the touched alarm are displayed.
The following shows an example in which [Initial Display Hierarchy] is set to the upper alarm in the [Basic] tab in the 
[Alarm Popup Display] dialog.

Device A Device B

Line2

Device A Device B

Line1

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit

Drive
module

Control
unit

Basic alarm

Middle alarm

Upper alarm

In alarm status

No alarm 
(Normal operation)

An error has 
occurred in the 
power supply unit.

An error has 
occurred in the 
control unit.

An error has 
occurred in the 
control unit.

An error has 
occurred in the 
power supply unit.

An error has 
occurred in the 
control unit.

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

-An error has occurred in line1.

Touch

-An error has occurred in device A.

Touch

Jun. 1, 2013 Power supply unit error

The level in the alarm hierarchy 
(upper alarm) specified as the initial 
target for the display is displayed. Displays all the upper alarms.

Display 
range

The middle alarms of the selected alarm 
are displayed.

The basic alarms of the selected alarm 
are displayed.

Display range

Switches to the middle.

Switches to the basic.
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If an alarm at the upper or middle level in a tree of the hierarchy occurs while alarms at the upper or middle level in 
another tree of the hierarchy are displayed, the new alarm is not displayed.

To display a new alarm which occurs, use the hierarchy switching device to display all the alarms in the specified 
level in the hierarchy, or display the upper alarm and switch the display down to the level in the hierarchy where the 
new alarm occurs.

➟9.1.4 ■4 (3) [Extended] tab
• When switching with the device set for [Hierarchy] of [Switching Device] in the [Extended] tab in the [Alarm Popup 

Display] dialog
All the alarms at the level in the hierarchy specified with a device are displayed.

➟9.1.4 ■4 [Alarm Popup Display] dialog
The following shows an example in which the hierarchy switching device is set to GD110.

Device A

POWER Control

Device A

POWER Control

Display 
range

A new alarm is 
not displayed.

Display 
range

While a specified 
range is displayed,

An alarm at the upper or middle level 
in another tree of the hierarchy occurs.
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In setting hierarchical alarms, it is recommended that the top of the alarm hierarchy be set for the initial target for the 
display.
When a lower level in the alarm hierarchy is set for the initial target for the display, all the alarms at the set level are 
displayed regardless of which tree they belong.
Example) Setting basic alarms for the initial targets for the display

When the cause of all the alarms at the displayed level in the hierarchy are eliminated or the user alarms to be 
displayed are switched with a device, all the alarms at the level in the hierarchy specified as the initial target for the 
display are displayed.

➟9.1.4 ■2 (3) (d) Switching the display using devices
Example) When the initial targets for the display are middle alarms and the cause of all the alarms at the displayed 
level in the hierarchy is eliminated

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

A 1254

B 348

A 1254

B 348
Device A

Line1

POWER

-An error has occurred in line1.

-An error has occurred in device A.

Jun. 1, 2013 Power supply unit error

Displays all the upper alarms.

Displays all the middle alarms.

Displays all the basic alarms.

GD110 2

GD110 1

GD110 0

All the basic alarms
are displayed.
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(c) Displaying alarms with a set font, character color, and background color
Set a font, character, and back ground color so as to make the popup display stand out and not to be missed.
Although level numbers and group numbers cannot be displayed in the alarm popup display, each of them can be 
indicated with a set display color.

➟9.1.4 ■4 [Alarm Popup Display] dialog

(d) Switching the display using devices
The display can be switched according to the device value.

➟9.1.4 ■4 [Alarm Popup Display] dialog
• Item to which the switching device can be set

*1 To set levels in the hierarchy, level numbers, and groups for alarms, use the user alarm observation.

➟9.1.2 ■7 [User Alarm Observation] dialog
• Display example

By changing the device value, the range of the target alarms for the display is narrowed.
The following shows an example in which the level switching device is set to GD10 and the group switching device 
to GD11.

Item to which the switching device 
can be set

Alarms to be displayed

User alarm System Alarm

Hierarchy*1 All the alarms at a specified level in the alarm 
hierarchy that occur are displayed.

-Level*1 Alarms with specified alarm numbers are displayed.

Group*1 Alarms in the specified group are displayed.

Priority display attribute

The display order is switched between the 
ascending order and descending order. 
Date and time of occurrence, level, or group can be 
selected as the basis on which the order is 
arranged.

The display order is switched between the 
ascending order and descending order. 
Date and time of occurrence, level, or group can be 
selected as the basis on which the order is 
arranged.

User alarm observation

The setting of the user alarm observation (alarm ID) 
displayed with the alarm display (user) can be 
changed. 
Multiple alarms can be displayed with one alarm 
display (user).

-
Basic comment group Comments to be displayed when an alarm occurs 

can be changed by comment group. 
Comments to be displayed can be changed 
according to the user and the purpose.

Middle comment group

Upper comment group

The cause of all the alarms at 
the target level in the hierarchy 
for the display is eliminated.

Displays all the alarms 
at the level in the hierarchy 
specified as the initial target 
for the display.
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For details of switching the display without devices, refer to the following.
➟9.1.4 ■3 Precautions

When the order in which alarms are displayed is changed by setting [Priority Display Attribute] in the [Extended] tab 
in the [Alarm Popup Display] dialog, it can be changed only while alarms are displayed if the targets are basic alarms.
While upper alarms or middle alarms are displayed, the order cannot be changed.
Even if you specify an alarm ID number for which [Popup Display] in the [Basic] tab in the [User Alarm Observation] 
dialog is not set, the alarm is displayed regardless of the setting of [Popup Display].
If you specify the alarm ID number for which [Popup Display] is set, only the alarm ID number is displayed.

(e) Writing the alarm information to devices
The alarm information touched in the alarm popup display can be written to devices.
Information that cannot be displayed in the alarm popup display, such as downtime, can be also written into devices.
The following lists the types of alarm information that can be written into devices.

• Alarm ID
• Comment group No.
• Comment No.
• Alarm status
• Occurrence date
• Occurrence time
• Date of restoration
• Time of restoration
• Date of confirmation

An alarm in the "Restored" status 
cannot be displayed in the alarm 
popup display.

Display target alarms

Error date and time Comment Alarm status Level
Jun. 1, 2013 16:50 Temperature anomaly Occurred 1
Jun. 1, 2013 14:25 Motor error 3

Group
1
1Occurred

Jun. 1, 2013 11:20 Oil error Checked 3
Jun. 1, 2013 10:00 Fuel error 3

2
2Occurred

Jun. 1, 2013 08:10 Internal pressure error Occurred 2
Jun. 1, 2013 07:40 Fuse error 1

1
1Restored

Error date and time Comment Alarm status Level
Jun. 1, 2013 14:25 Motor error 3

Group
1Occurred

Jun. 1, 2013 11:20 Oil error Checked 3
Jun. 1, 2013 10:00 Fuel error 3

2
2Occurred

Error date and time Comment Alarm status Level Group
Jun. 1, 2013 11:20 Oil error Checked 3
Jun. 1, 2013 10:00 Fuel error 3

2
2Occurred

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 14:25 Motor error

GD11 0

GD10 3

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 11:20 Oil error

GD11 2

GD10 3

When the following alarms have occurred
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

9 - 83



• Time of confirmation
• Level
• Group
• Frequency
• Cumulative time
• Downtime

Set [Touch Mode] to [Screen Switching] or [Stage Hierarchy Switching/Detail Display] in the [Basic] tab in the [Alarm 
Popup Display] dialog.

➟9.1.4 ■4 [Alarm Popup Display] dialog

■3 Precautions

The following shows the precautions for the alarm popup display.

(1) Precautions for drawing
(a) Initial display hierarchy and hierarchy switching device

In the alarm display (user) and alarm popup display, the level in the hierarchy specified in [Initial Display Hierarchy] is 
written into the hierarchy switching device with the following timing.
The level in the hierarchy to be displayed is switched.

• When switching screens (alarm display (user) only)
• At the first display of objects
• When the alarm observation ID number to be displayed is switched with the switching device for user alarm 

observation ID
For the setting of [Initial Display Hierarchy], refer to the following.

➟9.1.4 ■4 (1) [Basic] tab
For the setting of the switching devices for levels in the hierarchy and user alarm ID, refer to the following.

➟9.1.4 ■4 (3) [Extended] tab

(b) Switching comment displays or others with the hierarchy switching device
The leftmost bit of the hierarchy switching device changes to 1 by touch operations. Use mask processing and mask the 
device with 7FFFh so that the leftmost bit is always masked to 0.
Comment displays and others cannot work normally without mask processing.
Example) When switching comments to be displayed with the value of the hierarchy switching device

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Touch

D200 0601h
D201 2013h

Output the dates of the occurrences 
of selected alarms to devices.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Hierarchy switching device value Corresponding comment Comment to be displayed

0 0 Basic alarm on display

1 1 Middle alarm on display

2 2 Upper alarm on display
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• With mask processing

• Without mask processing

111111111111110 1

100000000000000 0

100000000000001 0

000000000000000 1

A 1254

B 348

A 1254

B 348

-Line abnormal stop

Displays the comment of comment No.2 
because the hierarchy switching device value is 2.

Upper alarm on display

Hierarchy switching device value 2

Hierarchy switching device value 1

AND
Mask value (7FFFh)

Touch Switch from the upper 
to the middle by touching.

A 1254

B 348

A 1254

B 348

-An error has occurred in the power supply unit.

Displays the comment of comment No.1 
because the hierarchy switching device value is 1.

Middle alarm on display

Mask processing

000000000000000 1

A 1254

B 348

A 1254

B 348

-Line abnormal stop

Displays the comment of comment No.2 
because the hierarchy switching device value is 2.

Upper alarm on display

Hierarchy switching device value 2

Switch from the upper to 
the middle by touching.

100000000000001 0 Hierarchy switching device value -32767

A 1254

B 348

A 1254

B 348

-An error has occurred in the power supply unit.

Comments are not displayed normally 
because the hierarchy switching device value 
becomes 1 and thus becomes -32767.

Touch
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(c) Settings for storing alarm data to data storage
To the alarm popup display, a touch switch for storing alarms cannot be assigned.
To place a button for storing alarm data, make either of the following settings.

• When setting the store trigger device for the alarm observation
Set [Store Trigger] in the [File Save] tab of the [User Alarm Observation] dialog or the [System Alarm Observation] 
dialog to store the alarm data.

➟9.1.2 ■7 [User Alarm Observation] dialog
➟9.1.3 ■5 [System Alarm Observation] dialog

• When saving alarm data with a touch switch for alarm display
On the screen where an alarm display object is placed, place a touch switch for alarm display to save the alarm data.

➟9.1.2 ■2 (6) Useful operations and functions
➟9.1.3 ■2 (7) Useful operations and functions

(d) Precautions for using comment groups
If a nonexistent value (column No.) is stored in the language switching device, the GOT displays "No message".

(2) Precautions for use
(a) When the display position overlaps with the positions of other objects

Objects such as touch switches hidden under the alarm popup display cannot be operated.
To operate those objects, change the display position of the alarm popup display.

➟9.1.4 ■2 (3) Useful operations and functions

(b) When the alarm popup display does not work
Review the settings of the alarm popup display.
For the details of the settings, refer to the following.

➟9.1.4 ■4 [Alarm Popup Display] dialog

(c) Order of priority in which alarms are displayed
• When selecting no target item for [Switching Device] in the [Extended] tab of the [Alarm Popup Display] dialog

Displays in order of date and time, from the latest.
For user alarms, displays only the alarms with the alarm ID numbers for which [Popup Display] of the user alarm 
observation is selected.

• When selecting the target items for [Switching Device] in the [Extended] tab of the [Alarm Popup Display] dialog
Displays according to the selected target items for the switching device.

• When selecting [User Alarm + System Alarm] for [Display Alarm] set in the [Basic] tab of the [Alarm Popup Display] 
dialog
If user alarms and system alarms occur simultaneously, only the system alarms are displayed.
The user alarms are displayed when the alarm status of all the system alarms turns "Restored".

A 1254

B 348

A 1254

B 348

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:30 Temperature anomaly

Changes the display position.

Jun. 1, 2013 10:30 Temperature anomaly

Touch the left end
of the display area.

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 11:35 Temperature anomaly

Displays in the first row.
Error date and time Comment
Jun. 1, 2013 11:35:52 Temperature anomaly
Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

Displays in the second row.
Displays in the third row.

Alarms that have occurred
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For how to recover from system alarms, refer to the following.
➟9.1.3 ■2 (2) Recovery from alarms

(d) Switching levels in the hierarchy to be displayed with the hierarchy switching device
When [Display Type] is set to [Fixed] in the [Basic] tab of the [Alarm Popup Display] dialog and the display target level in 
the hierarchy is switched with the hierarchy switching device, the display is updated with the timing set for [Switching 
Cycle].
Therefore, the display may not be switched soon after the level in the hierarchy is switched.

(e) Narrowing the range of alarms to be displayed when the number of alarms to be monitored is large
When the number of alarms to be monitored is large and the range of alarms to be displayed is narrowed, displaying the 
alarms may take seconds.

➟9.1.4 ■2 (3) (d) Switching the display using devices

(f) Display of the time of occurrence, confirmation, and restoration
For the time of occurrences, the clock data of the GOT is used.
For the precautions and restrictions of the clock function which manages the GOT clock data, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])

(g) Deleting the alarm popup display (network error)
When the alarm popup display appears for network errors which occur in the CC-Link communication unit and 
MELSECNET/H communication unit, the display is not deleted until the GOT is powered off or reset even if the cause of 
the alarms is eliminated.

■4 [Alarm Popup Display] dialog

Step 1 Select [Common] → [Alarm] → [Alarm Popup Display] from the menu.
Step 2 The [Alarm Popup Display] dialog appears.

➟(1) [Basic] tab
(2) [Text Format] tab
(3) [Extended] tab
(4) [External Output] tab

(1) [Basic] tab

If you display this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display]), some setting items are not 
available.

➟10.19.2 ■2 Usable functions
Set the type of the alarm popup display, the contents of the display, and the touch mode.

• When displaying this dialog by selecting [Common] → [Alarm] → [Alarm Popup Display] from the menu
The setting contents are applied to the alarm popup display appearing on the GOT.

• When displaying this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display])
The setting contents are applied to the alarm popup display appearing on a GOT Mobile function client.

A 1254

B 348

A 1254

B 348

Jun. 1, 2013 10:46 400 The communication with CPU failed.

Displays in the first row.
Error date and time Comment
Jun. 1, 2013 10:46:49 400 The communication with CPU failed.
Jun. 1, 2013 10:30:30 9     AC down has been detected

Jun. 1, 2013 07:11:15 803 The transient error has occurred.

Displays in the second row.
Displays in the third row.

System alarms that have occurred

Does not display until 
all the system alarms 
are eliminated.

Error date and time Comment

Jun. 1, 2013 11:35:52 Temperature anomaly
Jun. 1, 2013 09:45:30 Fuse error

Jun. 1, 2013 08:15:45 Oil error

User alarms that have occurred

Prioritizes system alarms in the order 
in which alarms are displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Use Alarm Popup Display]
Uses the alarm popup display.
Configure the following settings additionally.

• Alarm popup display settings
➟9.1.2 ■7 [User Alarm Observation] dialog

9.1.3 ■5 [System Alarm Observation] dialog
• Setting of the screen where an alarm message pops up
➟2.7.1 ■1 [Basic] tab

10.19.7 ■1 [Basic] tab
2) [Display Alarm]

Select the alarm type to be displayed.
The following shows selectable items.

• [User Alarm]
• [System Alarm]

For GT21 and GS21, the setting is fixed to [User Alarm].
For the order of priority in which multiple alarms that occur are displayed, refer to the following.

➟9.1.4 ■3 Precautions
3) [Display Number]

Select the number of the alarms to be displayed.
The following shows selectable items.

• [Multiple]: Displays multiple alarms in order.
• [One]: Displays the single alarm given the top priority.

For the order of priority in which multiple alarms that occur are displayed, refer to the following.
➟9.1.4 ■3 Precautions

4) [Display Type]
Select the display method of the comments for alarms.
The following shows selectable items.

• [Fixed]:
The comments to be displayed at the occurrence of an alarm are not scrolled in the display.
The part of a comment that extends off the display area, and the second and the following successive rows of 
a comment that involves multiple rows are not displayed.

• [Flow]:
The comments to be displayed at the occurrence of an alarm are displayed by scrolling from right to left.
For a comment which consists of multiple rows, the GOT displays whole comments including the comments 
after the second row.

1)
2)
3)
4)

8)
9)

10)

5)

6)

11)
12)
13)
14)

When selecting [Flow] for [Display Type]

4)

7)
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➟9.1.4 ■2 (2) Selecting the display method
5) [Switching Cycle]

This item can be set only when [Display Type] is [Fixed].
Set a cycle at which alarms to monitor are switched when multiple alarms occur.
The setting range is [1] to [60].

6) [Flow Rate]
This item can be set only when [Display Type] is [Flow].
Set the speed at which the display is scrolled.
The following shows selectable items.

• [High]: The text of comments flows at the speed of 200 dots a second.
• [Medium]: The text of comments flows at the speed of 100 dots a second.
• [Low]: The text of comments flows at the speed of 50 dots a second.

7) [Close up the space between alarm comments]
This item can be set only when [Display Type] is [Flow].
Set whether to reduce the space between scrolling comments.
When this item is selected, the space between comments is reduced to two one-byte characters.
When this item is deselected, a space of a half the screen width is inserted between comments.

8) [Display Position Switching]
Set whether to enable or disable display position switching of the alarm popup display.

• [Switch]: Enables the display position to be switched.
• [None]: Disables the display position to be switched.

9) [Contents]

10) [Display Order]
Set the order in which the items set for [Attribute] in [Contents] are displayed.
Move the display position of the selected item sideways by using the right button, the left button.

If either [Date of Occurrence] or [Comment] is selected for [Attribute] of [Contents], the right button and the left 
button are invalid.

11) [Display detailed system alarm information]
Not available to GT21 and GS21.
Displays the detailed information of system alarms.

12) [Initial Display Hierarchy]
This item can be set only when [Display Alarm] is [User Alarm] or [User Alarm + System Alarm].
Select a level in the alarm hierarchy to be displayed first when a user alarm occurs.

➟9.1.4 ■2 (3) Useful operations and functions
The following shows selectable items.

Item Description

[Display] Select the items to be displayed in the alarm popup display.

[Attribute]
Displays the items to be displayed in the alarm popup display.
• [Occurred]: Displays the date and time of occurrence of an alarm.
• [Comment]: Displays the comment which is set for the alarm.

[Date/Time Format]
Set the format in which the date and time of occurrence are displayed. 
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.
➟6.3.2 Date/time format settings

Right button
Left button

Selected item Moves to the left.Moves to the right.
Click the 
left button.

Click the 
right button.

When only [Date of Occurrence]

Only [Date of Occurrence] is 
displayed then the right and 
left button become invalid.
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• [Basic]
• [Middle]
• [Upper]

13) [Touch Mode]
Set the action taken when the alarm popup display is touched.

➟9.1.4 ■2 (3) Useful operations and functions
The following shows selectable items.

• [None]:
Select this item to disable touch operations.

• [Screen Switching]:
Displays the base screen with the screen No. set for [Destination Screen] or overlap window 1.

• [Hierarchy Switching /Detail Display]:
Switches levels in the hierarchy and displays the detail screen.
The operations differ depending on the alarm being displayed.
When upper alarms or middle alarms are displayed, the display is switched to a lower level in the alarm 
hierarchy.
When basic alarms are displayed, the detail screen is displayed.

14) [Destination Screen]
This item can be set only when [Touch Mode] is [Screen Switching].
Set the screen that appears when the alarm popup display is touched.
The following shows selectable items.

• [Base Screen]
• [Overlap 1]

After selecting either of the above screens, set the target screen number for the display.
The setting range is [0] to [32767].
The title of the selected screen is displayed.
9 - 90 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

(2) [Text Format] tab

If you display this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display]), some setting items are not 
available.

➟10.19.2 ■2 Usable functions
Set the text format of alarms.

• When displaying this dialog by selecting [Common] → [Alarm] → [Alarm Popup Display] from the menu
The setting contents are applied to the alarm popup display appearing on the GOT.

• When displaying this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display])
The setting contents are applied to the alarm popup display appearing on a GOT Mobile function client.

1) [Font]
Select the font of the displayed text.
The following shows selectable items.

• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

Set the style of the text to be displayed.
One style ([Bold], [Solid], or [Raised]) is settable only.
[Bold] button: Displays the text in bold.
[Solid] button: Displays the text with a shadow.
[Raised] button: Displays the text embossed.

2) [Solid Color]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)

3)

4)

5)

When selecting [No Switching (Fixed)] or 
[Comment Color (System Alarm Fixed Color)] for [Switching Type]

When selecting [Switch By Level] for [Switching Type]

When selecting [Switch By Group] for [Switching Type]

[Bold] button
[Solid] button

[Raised] button
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When [Solid] or [Raised] is selected as the text style, set the color of the shadow.
3) [Text Size]

For the details of each font and size, refer to the following.
➟1.2.5 Font specifications

4) [Alarm Text Color Switching]

*1 The following shows the relation between the set text color and text color displayed.

5) [Display Background Color]
Select the background color of the alarm popup display.

A semitransparent popup window appears in a user-specified color.

An opaque popup window appears in a user-specified color.

Item Description

[Switching Type]*1

Select how to use different text colors in displaying alarms.
The following shows selectable items.
• [No Switching (Fixed)]:

Displays texts in a single color.
• [Switch By Level]:

Gives different colors by level number.
• [Switch By Group]:

Gives different colors by group.
• [Comment Color (System Alarm: Fixed)] ([Comment Color] for GT21 and GS21):

Displays the alarm display (user) in text colors set for comment groups.
The settings other than that of the text color are displayed in the settings of the [Alarm 
Popup Display] dialog.
For the alarm display (system), texts are displayed in the color set for [Fixed/Default 
Color].

[Switch By Level], [Switch By Group], and [Comment Color (System Alarm Fixed Color)] 
can be set when [User Alarm] or [User Alarm + System Alarm] is selected for [Display 
Alarm] in the [Basic] tab.

[Fixed/Default Color]

When selecting one of the following items for [Alarm Text Color Switching], select a text 
color.
• None (Fixed)
• [Comment Color (System Alarm: Fixed)] ([Comment Color] for GT21 and GS21)

[Level Color] When selecting [Switch By Level] for [Alarm Text Color Switching], select a text color for 
each level.

[Group Color] When selecting [Switch By Group] for [Alarm Text Color Switching], select a text color for 
each group.

Alarms to be 
displayed

Target

Fixed Level Group Comment

User alarm
Displays in the color set 
for [Fixed/Default 
Color].

Displays in the color set 
in [Level].
Displays upper alarms 
and middle alarms in 
the color set for 1 of 
[Level].

Displays in the color set 
for [Group Color].
Displays upper alarms 
and middle alarms in 
the color set for 1 of 
[Group Color].

Displays in the color set 
for each comment 
group.
In a case where no 
comment exists, 
displays in the color set 
for [Fixed/Default 
Color].

System Alarm Displays in the color set 
for 1 of [Level].

Displays in the color set 
for 1 of [Group Color].

Displays in the color set 
for [Fixed/Default 
Color].

GOT Graphic Ver.2

GOT Graphic Ver.1
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(3) [Extended] tab

Set the operation of switching displays for the alarm popup display by devices.
• When displaying this dialog by selecting [Common] → [Alarm] → [Alarm Popup Display] from the menu

The setting contents are applied to the alarm popup display appearing on the GOT.
• When displaying this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display])

The setting contents are applied to the alarm popup display appearing on a GOT Mobile function client.

1) [Security Level]
Set the security level of display and operation.

Item Description

[Display]
Set the security level of display. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security.

[Operation]

Set the security level of operation. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security. 
The setting of security level of [Operation] must be set to the one exceeding the security 
level of [Display].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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2) [Switching Device]
Select items to switch the display using devices.

➟9.1.4 ■2 (3) Useful operations and functions

Item Description

[Hierarchy]

Available only for the alarm display (user). 
Switches the level in the alarm hierarchy to be displayed using the device value. 
All the alarms at the specified level in the alarm hierarchy are displayed. 
Set the switching device.
➟6.1.2 How to set devices
Store values to the device as follows to switch the level in the alarm hierarchy.

• Specifies the destination level in the alarm hierarchy for b1 to b0.
00 (0): Basic alarm
01 (1): Middle alarm
xxx10 (2): Upper alarm

• Using b14 to b2 is prohibited.
• To b15, store the type of operations of switching levels in the hierarchy. (Identifier of 

hierarchy switching controllers)
To switch levels in the hierarchy using the hierarchy switching device, always set 0 to this 
bit.
0: Switching by using the switching device
1: Switching by touching the display part

For the precautions of switching the comment display or other items using devices, refer 
to the following.
➟9.1.4 ■3 Precautions

[Level]

Available only for the alarm display (user). 
Only the alarms with a specified level No. are displayed. 
Set the switching device.
➟6.1.2 How to set devices
Store the level No. of alarms to be displayed to the device.
• To display a specific level, specify a level No. within 1 to 255.
• If a nonexistent level No is specified, alarms are not displayed.
• To display all levels, specify the level No. 0 or a No. over 256.

[Group]

Available only for the alarm display (user). 
Only the alarms with a specified group No. are displayed. 
Set the switching device.
➟6.1.2 How to set devices
Store the group No. of alarms to be displayed to devices.
• To display a specific group, specify a group No. within 1 to 255.
• If a nonexistent group No is specified, alarms are not displayed.
• To display all groups, specify the group No. 0 or a No. over 256.

[Priority Display Attribute]

Switch the item to be the sort criteria according to the device values. 
Set the switching device.
➟6.1.2 How to set devices
Store values to the device to switch the order of alarm display.

• For b3 to b0, specify the sort criteria.
□000h: Normal (date and time of occurrence)
□001h: Date and time of occurrence
□005h: Level (User alarm only)
□006h: Group (User alarm only)

• Using b14 to b4 is prohibited.
• Ascending or descending is specified for b15.

000□h: Descending
800□h: Ascending

If a value other than the above is stored, alarms are displayed in the order of the date and 
time of occurrence.

[User Alarm Observation]

Available only for the alarm display (user). 
The specified user alarm is displayed. 
Set the switching device.
➟6.1.2 How to set devices
• Store the alarm ID of the user alarm observation to the device.
• The alarm with a stored alarm ID number is displayed regardless of the settings of [Popup 

Display] of user alarm observation.
• When 0 is stored to a device, only the alarm with an alarm ID for which [Popup Display] 

of the user alarm observation is set is displayed.
• If a nonexistent alarm ID is specified, alarms are not displayed.

b14 to b2 b1 b0b15

b14 to b4 b2b3b15 b1 b0
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(4) [External Output] tab

Configure the setting for writing the information of touched alarm in the alarm popup display into devices.
• When displaying this dialog by selecting [Common] → [Alarm] → [Alarm Popup Display] from the menu

The setting contents are applied to the alarm popup display appearing on the GOT.
• When displaying this dialog from the [GOT Mobile Setting] window ([Alarm Popup Display])

The setting contents are applied to the alarm popup display appearing on a GOT Mobile function client.

[Basic Alarm Comment Group]

Available only for the alarm display (user). 
Switch the comment group to be displayed in the basic alarm according to the device 
values. 
Set the switching device.
➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in 

the user alarm observation.
• When a nonexistent comment group No. is specified, No message is displayed.

[Middle Alarm Comment Group]

Available only for the alarm display (user). 
Switch the comment group to be displayed in the middle alarm according to the device 
values. 
Set the switching device.
➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in 

the user alarm observation.
• When a nonexistent comment group No. is specified, No message is displayed.

[Upper Alarm Comment Group]

Available only for the alarm display (user). 
Switch the comment group to be displayed in the upper alarm according to the device 
values. 
Set the switching device.
➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in 

the user alarm observation.
• When a nonexistent comment group No. is specified, No message is displayed.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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1) [Enable External Output]
Write the information of touched alarm into devices.

➟9.1.4 ■2 (3) Useful operations and functions
• [Trigger Type]:

Select the timing to write the alarm information into a device.
Select [Ordinary] to write the alarm information into the device when the alarm is touched.
Select [ON] to write the alarm information into the device when the alarm display area is touched while the 
device is on.
Select [OFF] to write the alarm information into the device when the alarm display is touched while the device 
is off.

• [Trigger Device]:
When selecting [ON] or [OFF] in [Trigger Type], set the device to be a trigger.

➟6.1.2 How to set devices
2) [Device]

Set the devices to which the information of a touched alarm is written.

Item Description

[First Device]
Set the start device (word device) to which the information of the alarm is written. 
When items to be written are selected, the successive devices following the start device 
are automatically set.

[Alarm ID] Available only for the alarm display (user). 
Select this item to write the alarm ID into devices.

[Comment Group No.]
Available only for the alarm display (user). 
Select this item to write the comment group No. of the comment displayed with the alarm 
display.

[Comment No.] Available only for the alarm display (user). 
Select this item to write the comment No. of the comment displayed with the alarm display.

[Identification Data] Available only for the alarm display (system). 
Select this item to write the alarm identification data into devices.

[Error No.] Available only for the alarm display (system). 
Select this item to write the error No. of an alarm into devices.

[Channel]

Available only for the alarm display (system). 
Select this item to write the channel No. of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[Network No.]

Available only for the alarm display (system). 
Select this item to write the network No. of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[Station No.]

Available only for the alarm display (system). 
Select this item to write the station No. of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[CPU No.]

Available only for the alarm display (system). 
Select this item to write the CPU No. of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[Screen No.]

Available only for the alarm display (system). 
Select this item to write the screen No. of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[Definition Screen No.]

Available only for the alarm display (system). 
Select this item to write the definition screen No. of an alarm as added information into 
devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information

[Object ID]

Available only for the alarm display (system). 
Select this item to write the object ID of an alarm as added information into devices. 
For the added information, refer to the following.
➟9.1.4 ■4 (4) (a) Added information
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[Alarm Status]

Select this item to write the alarm status into devices.

• b0:
When the alarm is in the "Occurred" status, 1 is stored, and when the alarm is in the 
"Restored" status, 0 is stored.

• b1:
When the alarm is in the "Checked" status, 1 is stored, and when the alarm is unchecked, 
0 is stored.

• b2:
When writing the alarm status into devices is enabled, 1 is stored, and when writing the 
alarm status into devices is disabled, 0 is stored.

• b15 to b3:
Using these bits is prohibited.

For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger

[Occurred Date]

Select this item to write the date when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Occurred Time]

Select this item to write the time when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Restored Date]

Select this item to write the date when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Restored Time]

Select this item to write the time when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Checked Date]

Select this item to write the date when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Checked Time]

Select this item to write the time when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger
For the description of the date and time to be written, refer to the following.
➟9.1.4 ■4 (4) (c) Descriptions of the date and time to be written

[Level]

Available only for the alarm display (user). 
Select this item to write the level No. of an alarm into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger

[Group]

Available only for the alarm display (user). 
Select this item to write the group No. of an alarm into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger

[Frequency]

Available only for the alarm display (user). 
Select this item to write the frequency of alarm occurrences into devices. 
For the details of the write trigger, refer to the following.
➟9.1.4 ■4 (4) (b) Write trigger

[Cumulative Time]

Available only for the alarm display (user).
Select this item to write the cumulative time of alarms into devices.
For the details of the write trigger, refer to the following.

➟9.1.4 ■4 (4) (b) Write trigger
The cumulative time (in hours and minutes) is stored in BCD code in two word devices.
Example) When the cumulative time is 12 hours and 35 minutes
Device value: 1235

Item Description

b15 to b3 b2 b1 b0
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

9 - 97



(a) Added information
• By adding the information of an error that has occurred, it becomes easy to identify where the error has occurred.

The added information which is not related to the error is not added even if the information is set.

*1 The number of the symbol * represents the number of the digits of the screen No.
*2 When a displayed number contains a number of digits less than that shown in the table, the number is displayed with 0 

padded.
• The following shows a display example of added information.

Channel (1), device (X1000), screen No. (overlap window 3, screen No. 251), definition screen No. (window screen, 
screen No. 251), object ID (10000), function name (shape display)

[Down Time]

Available only for the alarm display (user).
Select this item to write the down time of alarms into devices.
For the details of the write trigger, refer to the following.

➟9.1.4 ■4 (4) (b) Write trigger
The downtime (in hours and minutes) is stored in BCD code in two word devices.
Example) When the downtime is 2 hours and 10 minutes
Device value: 210

[Select All] button Selects all alarm information.

[Deselect] button Cancels all the selected alarm information.

Added information Description

(1) Error message Displays the error code of a system alarm and the error message.

(2) Channel Displays the channel No. 
The display type is DEV: Ch No.

(3) Network No. Displays the network No. with three digits number. *2

(4) Station Displays the station No. with three digits number. *2

(5) CPU No. Displays the CPU No.

(6) Device Displays the device.

(7) Screen No.*1*2

Displays the screen type and the screen No.

Base screen BASE: *****

Overlap window 1 to 5 OVL1: ***** to OVL5: *****

Superimpose window 1 to 2 SPI1: ***** to SPI2: *****

User customize dialog DLG: *****

Operation panel PNL: *****

Key window KEY: ******

Base screen (GOT Mobile) MBL-BASE: *****

Overlap window 1 to 2 (GOT Mobile) MBL-OVL1: ***** to MBL-OVL2: *****

Superimpose window 1 to 2 (GOT Mobile) MBL-SPI1: ***** to MBL-SPI2: *****

(8) Definition screen 
No.*1*2

Displays the definition screen type and the screen No.

Base screen B: *****

Window screen W: *****

Report screen R: *****

Mobile screen MB: *****

(9) Object ID Displays the object ID.

(10) Function name Displays the function name. 
Switches languages with the language switching.

(11) Drive name Displays the drive name. 
The display type is DRV: Drive name.

Item Description

(1) (2) (7) (8) (9)(3) (4) (5) (6) (10) (11)

[Error Message] [Channel] [Network No.]-[Station No.]/[CPU No.] [Device]/[Screen Type]/[Definition Screen No.]/[Object ID]/[Function Name]/[Drive Name]
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If added information is displayed, the message is longer.
When all information is not be displayed, select Flow as the display type.

• For the device to which offset is specified, the device name and address after the offset are displayed.
If the address after the offset is out of the range, ?? is displayed.
The following shows the display example of a case where the device M1000 (range: 0 to 61424) is offset.
Offset device 60000 → The device M61000 after offset is displayed.
Offset device 61000 → ?? is displayed because the device after offset is out of the range.

(b) Write trigger
• Available alarm hierarchy for writing alarm information for the alarm display (user)

Only when the basic alarm is touched, the alarm information is written into devices.
• Writing by the collection mode

The available data for writing differs according to the collection mode which is set in the alarm observation.
For details, refer to the following.

➟9.1.2 ■1 Specifications of the user alarm observation

(c) Descriptions of the date and time to be written
The date and time are respectively stored in two word devices.
The following describes the case in which the time of occurrence is written into D254 (2 points) and the date of occurrence 
is written into D256 (2 points).

• Date
Store the year, month, and day with BCD code.

• Time
Stores the hour, minute, and second with BCD code.

Example) Jun. 1, 2013 12:24:56

G01-322 The specified device No. is out of the range. Check the available range. DEV:Ch1 X1000/OVL3:00251/W:00251/ID:10000/Shape display

D254

D255

Month (1 to 12) Date (1 to 31)

Two upper 
digits of year

Two lower 
digits of year

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

Minute (0 to 59) Second 
(0 to 59)

00 Hour (0 to 23)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D254

D255

06 01

20 13

(Month) (Date)

(Year)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

24 56

00 12

(Minute) (Second)

(Hour)

b15 to b8 b7 to b0

b15 to b8 b7 to b0
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■5 Relevant settings

Set the relevant settings other than the specific settings for the alarm popup display as required.
The following shows the functions that are available by the relevant settings.

(1) Property of screens

The property can be set for each screen.
Select the screen editor on which the key window is to be set and select [Screen] → [Screen Property] from the menu to 
display the [Screen Property] dialog.

➟2.7 Changing Screen Property

(2) GOT environmental settings (System information)

Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

*1 Not available to GT21 and GS21.

(3) GOT internal device

➟1.2.7 ■1 (1) GOT internal devices (GB, GD, and GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Setting whether to display the alarm popup display or not for each screen 
Selecting the display position of the alarm popup display from among three 
positions: the top row, the center row, or the lower row

Set this function with the following items of the [Basic] tab.
• [Use Alarm Popup Display]
• [Display Position]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Turning off the key Input signal (Read device: System signal 1-1.b3) [System Signal 1-1]

Disabling all the key inputs (Read device: System signal 1-1.b9) [System Signal 1-1]

Resetting system alarms and system information (GOT error code, GOT Error 
Detection signal) (Read device: System signal 1-1.b13)*1 [System Signal 1-1]

Notifying the key input. (Write device: System signal 2-1.b3) [System Signal 2-1]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Storing the channel No. that has been assigned to the channel where a system 
alarm (GOT error) occurs 
(Write device)

GS262

Storing the channel No. that has been assigned to the channel where a system 
alarm (CPU error) occurs 
(Write device)

GS263

Storing the channel No. that has been assigned to the channel where a system 
alarm (network error) occurs (Write device) GS264

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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9.1.5 Viewing alarm events (Alarm display)

➟■1 Specifications of the alarm display
■2 How to use the alarm display
■3 Precautions
■4 [Alarm Display(User)] dialog
■5 [Alarm Display(System)] dialog
■6 Relevant settings

The alarm display object lists the collected user or system alarm events.
For collecting user or system alarm events, refer to the following.

➟9.1.2 Collecting alarms by monitoring devices
9.1.3 Collecting alarms by monitoring the system

■1 Specifications of the alarm display

(1) Maximum number of objects on one screen
The maximum number of objects on one screen depends on the GOT model.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Line No. 1
A 1254

B 348

A 1254

B 348

An alarm 
occurred!

The information on alarms 
is displayed in a list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT
Maximum number of objects on one screen

Alarm Display (User) Alarm Display (System)

GT27, GT25, GT23, GT SoftGOT2000, GS25 33 9

GT21, GS21 1 Not available to GT21 and GS21.
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(2) Alarm events to be listed
➟9.1.5 ■4 [Alarm Display(User)] dialog
➟9.1.5 ■5 [Alarm Display(System)] dialog

Select the type of alarm events to be listed.
• All alarms
All alarm events are listed.

• Alarms being raised
The alarm events excluding the reset alarm events are listed.

Example) Alarm display (user)

■2 How to use the alarm display

(1) Placing an alarm display object
The following outlines how to set an alarm display object.

Step 1 Place an alarm display object on the screen editor.

➟6.5.1 Placing figures and objects
Step 2 The relevant key code switches are placed together.

The user ID of the alarm display object is assigned to the switches.
Delete unnecessary key code switches.
Place additional key code switches as necessary.

➟8.2.11 [Key Code Switch] dialog
Step 3 Configure the settings of the alarm display object.

➟9.1.5 ■4 [Alarm Display(User)] dialog
9.1.5 ■5 [Alarm Display(System)] dialog

For the settings common to the objects, refer to the following.
➟6.5.5 Common setting for objects

(Occurred) (Comment) (Restored) (Checked)
Jun. 1, 2013 12:10 Temperature anomaly - -
Jun. 1, 2013 11:45 Fuse error 12:25-

-
Jun. 1, 2013 11:30 Oil error 12:05 11:50
Jun. 1, 2013 10:47 Fuel error 10:55
Jun. 1, 2013 09:30 Internal pressure error 10:14

09:45
09:48

Jun. 1, 2013 08:58 Light error 09:15

Alarm status

Error date and time Comment Restored Checked
Jun. 1, 2013 12:10 Temperature anomaly
Jun. 1, 2013 11:45 Fuse error 12:25
Jun. 1, 2013 11:30 Oil error 12:05 11:50
Jun. 1, 2013 10:47 Fuel error 10:55
Jun. 1, 2013 09:30 Internal pressure error 10:14

09:45
09:48

Jun. 1, 2013 08:58 Light error 09:15

[All Alarm]

Error date and time Comment Restored Checked
Jun. 1, 2013 12:10 Temperature anomaly
Jun. 1, 2013 11:45 Fuse error 12:25
Jun. 1, 2013 10:47 Fuel error 10:55

[Generating Alarm]

As the alarms for the oil error, internal pressure error, and light 
error have been reset, the events are not listed accordingly.

All alarm events are listed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Display method of comments
You can select either of the following display methods.

➟9.1.5 ■4 [Alarm Display(User)] dialog
　 9.1.5 ■5 [Alarm Display(System)] dialog

• [Fixed]
Does not scroll a comment displayed at an alarm occurrence.
When a comment extends off the display area, the part outside the area and the second and subsequent rows are not 
displayed.

• [Flow all]
Scrolls a full comment displayed at an alarm occurrence from right to left.

• [Flow as required]
Does not scroll a comment fully displayed within the display area.
Scrolls a comment extending off the display area and a multiple-row comment from right to left.

• [Flow the selected row]
Scrolls only the comment selected among the comments displayed at an alarm occurrence from right to left.

Display example) Alarm display (user)

(3) Display order of alarms
Set the display order of alarms as follows.

Step 1 Specify an item for sorting the display of alarms.
The display of alarms is sorted according to the specified item.
Display example) Displaying user alarms in the chronological order

Setting example) Configure the setting in the [Style] tab of the [Alarm Display(User)] dialog as follows.

Error date and time Comment Restored Checked
Jun. 1, 2013 12:10 A temperature
Jun. 1, 2013 11:45 Check the hyd 12:25
Jun. 1, 2013 11:30 Motor error 12:05 11:50

Displayed comments

Error date and time Comment Restored Checked
Jun. 1, 2013 12:10 power supply unit.
Jun. 1, 2013 11:45 raulic pressure. 12:25
Jun. 1, 2013 11:30 Motor error 12:05 11:50

Error date and time Comment Restored Checked
Jun. 1, 2013 12:10 unit. Check the
Jun. 1, 2013 11:45 Check the 12:25
Jun. 1, 2013 11:30 Motor error 12:05 11:50

For a comment with multiple lines, 
the subsequent lines are also displayed.

Comment No. 1 (comment group)

A temperature anomaly has occurred in the power supply unit. 
Check the fuse.

Comment No. 2 (comment group)

Check the hydraulic pressure.

Comment No. 3 (comment group)

Motor error

Comment with 
multiple rows

Display when the display type is [Flow as required]

A comment extending off the display area 
and a multiple-row comment scroll 
from right to left.

Group

Jun. 1, 2013 Checked - 2 - 1
Jun. 1, 2013 5 00:2004:10 2 1

Jun. 1, 2013 Occurred - - 1 -- 1
1
2

Error date and time Restored Checked Frequency Down TimeCumulative Time Level

16:10
18:30
20:00

Comment

Hydraulic pressure failure
Checked 16:30 16:20

18:50 00:20

Jun. 1, 2013 Checked 4 2
Jun. 1, 2013 1 01:0001:00 2 1

1
13:30
14:00 Motor error

Checked 14:30 13:50
14:10 02:30 01:0015:00

Alarm status
Power supply unit error

Drive module error

Light error

Sorting user alarms in the chronological order
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Step 2 You can change the item for sorting the display of alarms.
Display example) Sorting user alarms in the descending order of frequency of occurrences

Setting example) Configure the setting in the [Extended] tab of the [Alarm Display(User)] dialog as follows.

• Display order of when both [Display Order] in the [Display] tab and [Priority Display Attribute] in [Switching Device] in 
the [Extended] tab are set
When both [Display Order] in the [Display] tab and [Priority Display Attribute] in [Switching Device] in the [Extended] tab 
are set, the display order set in [Priority Display Attribute] has priority.

Set [Occurred] as an item 
for sorting alarms.

Set [Reverse chronological] 
as the display direction.

Group

Jun. 1, 2013 Checked - 2 - 1

Jun. 1, 2013 5 00:2004:10 2 1

Jun. 1, 2013 Occurred - - 1 -- 1
1
2

Error date and time Restored Checked Frequency Down TimeCumulative Time Level
16:10

18:30
20:00

Comment

Hydraulic pressure failure

Checked 16:30 16:20

18:50 00:20
Jun. 1, 2013 Checked 4 2

Jun. 1, 2013 1 01:0001:00 2 1

1

13:30

14:00 Motor error

Checked 14:30 13:50

14:10 02:30 01:0015:00

Alarm status

Power supply unit error

Drive module error

Light error

Sorting user alarms according to the frequency 
of occurrences (in the descending order)

Switching device D100 9

The sort criteria can be changed according to the value 
in the switching device (priority display attribute).

0: Without specification 
    (sorting by the occurrence date and time)
1: Occurred
2: Restored
3: Checked
4: Comment (comment No.)
5: Level
6: Group
7: Status
    (Ascending: Checked → Restored → Occurred)
    (Descending: Occurred → Restored → Checked)
9: Freque
10: Cumulative Time
11: Down Time
12: Monitored alarm No.
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(4) Switching the levels in the alarm hierarchy
Only available to the alarm display (user).
Switch the levels in the alarm hierarchy by one of the following methods.

• Touching the screen
Touch the alarm display (user) or a touch switch for the alarm display (user).

➟9.1.5 ■2 (11) Touch switches for the alarm display
• Using a device

Specify a device for [Hierarchy] in [Switching Device].
➟9.1.5 ■4 (5) [Extended] tab

The following shows a system hierarchy example to explain alarm events to be displayed by each method.

(a) Touching the screen
The alarm display object lists the alarm events in the level directly below the current level in the alarm hierarchy.
Example) When switching the upper level to another level by touching an event on the alarm display (user)

Device A Device B

Line2

Device A Device B

Line1

Power 
supply 

unit
Drive

module
Control

unit
Power 
supply 

unit
Drive

module
Control

unit
Power 
supply 

unit

Drive
module

Control
unit

Power 
supply 

unit
Drive

module
Control

unit

Basic-level alarm

Middle-level alarm

Upper-level alarm

In alarm status

No alarm 
(Normal operation)

An error has 
occurred in the 
power supply unit. 
(Group 1)

An error has 
occurred in the 
control unit. 
(Group 3)

An error has 
occurred in the 
control unit. 
(Group 3)

An error has 
occurred in the 
power supply unit. 
(Group 4)

An error has 
occurred in the 
control unit. 
(Group 6)
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While alarm events are displayed, if an alarm occurs in any other branch of the system hierarchy, the alarm event will not 
be displayed.

Device A Device B Device B

Line1 Line2

POWER Control POWER ControlControl

Device A Device B

POWER Control Control

POWER

The upper-level alarm events are initially displayed.

Select an event to switch to the middle level in the alarm hierarchy.

The middle-level alarm events are displayed.

Select an event to switch to the basic level in the alarm hierarchy.

The basic-level alarm events are displayed.

All upper-level alarm events are displayed.

Display range

Display range

Error date and time Comment Restored Checked

Jun. 1, 2013 14:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:10 An error has occurred in the control unit. 12:25

Error date and time Comment Restored Checked

- - Line1 abnormal stop - -

- - Line2 abnormal stop --

Error date and time Comment Restored Checked

- - Line1 abnormal stop - -

- - Line2 abnormal stop --

Error date and time Comment Restored Checked

- - An error occurs in the device A. - -

- - An error occurs in the device B. --

Error date and time Comment Restored Checked

- - An error occurs in the device A. - -

- - An error occurs in the device B. --
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To display the new alarm event, perform one of the following operations.
• Set a hierarchy switching device to display all the alarm events in the specified level in the alarm hierarchy.
• Switch the level in the alarm hierarchy.

(b) Using a device
The alarm display object lists all the alarm events in the level specified with the hierarchy switching device.
Example) When the hierarchy switching device is set to GD110

(c) How to switch to a higher level in the alarm hierarchy
To switch the basic level to the upper or middle level in the alarm hierarchy, use a touch switch for the alarm display (user).

➟9.1.5 ■2 (11) Touch switches for the alarm display

POWER

POWER

Alarm events in device A in line 1 are displayed.

Display range

The new alarm event in device B in line 2 is not displayed.

Display range

A new alarm has occurred.

Error date and time Comment Restored Checked

Jun. 1, 2013 14:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:10 An error has occurred in the control unit. 12:25

Error date and time Comment Restored Checked

Jun. 1, 2013 14:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:10 An error has occurred in the control unit. 12:25

Device A Device B Device B

Line1 Line2

POWER Control POWER ControlControl

Device A Device B

POWER Control

Device B

POWER ControlControl

POWER Control Control ControlPOWER

All upper-level alarm events are displayed.

All middle-level alarm events are displayed.

All basic-level alarm events are displayed.

Display range

Display range

Error date and time Comment Restored Checked

- - Line1 abnormal stop - -

- - Line2 abnormal stop --

GD110 2

Error date and time Comment Restored Checked

- - An error occurs in the device A. - -

- - An error occurs in the device B. --

- - An error occurs in the device B. --

GD110 1

Error date and time Comment Restored Checked

Jun. 1, 2013 14:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:10 An error has occurred in the control unit. 12:25

11:00Jun. 1, 2013 10:00 An error has occurred in the control unit.

Jun. 1, 2013 09:15 An error has occurred in the power supply unit. 09:55

Jun. 1, 2013 08:35 An error has occurred in the control unit. 09:40

10:10

10:20

GD110 0
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(d) Initially-displayed level in the alarm hierarchy
You are recommended to set upper-level alarm events to be initially displayed.
If you set lower-level alarm events to be initially displayed, all the alarm events in the level will be displayed.
Example) When the initially-displayed level is set to the basic level

(e) Timing for switching to the initially-displayed level
When you perform any of the following operations using a device, the alarm display object lists all alarm events in the 
initially-displayed level in the alarm hierarchy.

• Switching between alarm IDs
• Switching between languages

(5) Switching the display using devices
The alarm events can be switched according to the value of the specified device.
Set [Switching Device] on the [Extended] tab.

➟9.1.5 ■4 (5) [Extended] tab
9.1.5 ■5 (5) [Extended] tab

The following shows the setting items in [Switching Device].
• Alarm display (user)

• Alarm display (system)

The following shows an example of displaying alarm events on the alarm display (user).
Example) When D102 is set for [Level] and D103 is set for [Priority Display Attribute] in [Device Switching]

All basic-level alarm events are displayed.

Error date and time Comment Restored Checked

Jun. 1, 2013 14:25 An error has occurred in the power supply unit.

Jun. 1, 2013 12:10 An error has occurred in the control unit. 12:25

11:00Jun. 1, 2013 10:00 An error has occurred in the control unit.

Jun. 1, 2013 09:00 An error has occurred in the power supply unit. 09:20

Jun. 1, 2013 08:40 An error has occurred in the control unit. 08:50

11:00

10:20

Setting item Description

[Hierarchy] The alarm events in the specified level in the alarm hierarchy are displayed.

[Level] The alarm events in the specified level are displayed.

[Group] The alarm events in the specified group are displayed.

[Priority Display Attribute]

The alarm events are sorted in ascending or descending order.
Select a sort criterion from the following.
• Date and time of occurrence
• Date and time of restoration
• Date and time of confirmation
• Comment number
• Level
• Group
• Alarm status (Occurring, reset, or checked)
• Frequency
• Cumulative time
• Down time
This setting is applied only to basic-level alarm events.

[Basic Alarm Comment Group]
The alarm events are displayed using the comments of the specified comment group.
You can change the comments according to your purpose.

[Middle Comment Group]

[Upper Comment Group]

Setting item Description

[Priority Display Attribute]

The alarm events are sorted in ascending or descending order.
Select a sort criterion from the following.
• Date and time of occurrence
• Date and time of restoration
• Date and time of confirmation
• Alarm status (Occurring, reset, or checked)
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(6) Formatting the column header of the table

The format of the column header is user-changeable.

Set [Title Format] on the [Text] tab.
➟9.1.5 ■4 (3) [Text] tab

9.1.5 ■5 (3) [Text] tab

(7) Setting text colors for alarm events
Setting text colors facilitates visual identification of alarm events.

Occurrence date and time Comment Level
Jun. 1, 2013 16:50 Temperature anomaly 1
Jun. 1, 2013 14:25 Motor error 3

3Jun. 1, 2013 11:20 Oil error
Jun. 1, 2013 10:00 Fuel error 3
Jun. 1, 2013 08:10 Internal pressure error 3
Jun. 1, 2013 07:40 Fuse error 2

Status
Occurred
Occurred
Checked

Restored
Restored
Restored

All Major Moderate

Error date 
and time Level Alarm

Minor

The following alarm events are displayed.

Touch switches for switching the alarms to be displayed

Severity levels

Sort criteria

Error date 
and time

Level

Alarm

All

Major

Moderate

Minor

Switching the display according to the level

Switching the sort criterion

Displays all alarm events. (D102: 0)

Displays alarm events in level 1. (D102: 1)

Displays alarm events in level 2. (D102: 2)

Displays alarm events in level 3. (D102: 3)

Sorts the alarm events based on the date and time 
of occurrence in reverse chronological order. (D103: 1)
Sorts the alarm events in descending 
order of level. (D103: 5)
Sorts the alarm events in descending 
order of alarm status. (D103: 7)

Occurrence date and time Comment Level
Jun. 1, 2013 16:50 Temperature anomaly 1

Jun. 1, 2013 14:25 Motor error 3
3Jun. 1, 2013 11:20 Oil error

Jun. 1, 2013 10:00 Fuel error 3

Jun. 1, 2013 08:10 Internal pressure error 3

Jun. 1, 2013 07:40 Fuse error 2

Status
Occurred

Occurred
Checked

Restored

Restored

Restored

Occurrence date and time Comment Level

Jun. 1, 2013 14:25 Motor error 3
3Jun. 1, 2013 11:20 Oil error

Jun. 1, 2013 10:00 Fuel error 3

Jun. 1, 2013 08:10 Internal pressure error 3

Status

Occurred
Checked

Restored

Restored

Occurrence date and time Comment Level
Jun. 1, 2013 14:25 Motor error 3

3Jun. 1, 2013 11:20 Oil error

Jun. 1, 2013 10:00 Fuel error 3
Jun. 1, 2013 08:10 Internal pressure error 3

Status
Occurred

Checked

Restored
Restored

The alarm events are sorted 
based on the alarm status.

Switching device
(level): D102

Switching device
(priority display attribute): 
D103

Minor AlarmWrite 3 into D102. Write 7 into D103.

Only the alarm events in level 3 are displayed.

0 3

0 7

Only the alarm events in level 3 are displayed. The alarm events are sorted based on 
the alarm status.
(Occurred → Restored → Checked)

Occurrence date and time Comment

Jun. 1, 2013 Fuse error
Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

The text color, text style, 
and KANJI region can be set.

Occurrence date and time Comment

Jun. 1, 2013 Fuse error
Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly The alarm events 
are identifiable visually.
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Set [Table Format] on the [Text] tab.
➟9.1.5 ■4 (3) [Text] tab

9.1.5 ■5 (3) [Text] tab

(8) Switching the title row language or comment language with the language switching device
By setting multiple languages in a comment group, you can switch the display language with the language switching 
device.
Set the date format in [Language Switching] in the GOT environmental settings.

For setting comments, refer to the following.
➟5.8 Comment Setting ([Comment])

For the language switching settings, refer to the following.
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

発生日時 コメント

13/06/01 ヒューズエラー
13/06/01 オイルエラー
13/06/01 燃料エラー

13/06/01 温度異常

EnglishJapanese

Occurred Comment

Fuse error
Oil error
Fuel error

Temperature is abnomal
発生日時 コメント

13/06/01 ヒューズエラー
13/06/01 オイルエラー
13/06/01 燃料エラー

13/06/01 温度異常

EnglishJapaneseEnglishJapanese

01/06/13
01/06/13
01/06/13
01/06/13

1 2Language switching device: Language switching device:

Setting comment group No.2 to comments

Switching between display languages with the language switching device

Setting the date format in [Region Setting]

Setting comment group No.1 to the title row
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(9) Writing the information on the touched alarm event into devices
The information on the alarm event touched on the alarm display object is writable to devices.

Configure the following settings.
• On the [Alarm Setting] tab, select [Selection] or [Operation] for [Touch Mode].
• On the [External Output] tab, select [Use External Output].

➟9.1.5 ■4 (7) [External Output] tab
9.1.5 ■5 (7) [External Output] tab

(10)Writing the number of alarms into devices
The number of alarms targeted for listing is writable to devices.
On the [External Output] tab, set [Display Target Alarm Number Output].

➟9.1.5 ■4 (7) [External Output] tab
9.1.5 ■5 (7) [External Output] tab

(11)Touch switches for the alarm display
To use the touch switches for the alarm display, select them from the library of GT Designer3.
The text and shape of each switch is user-changeable.
Alternatively, assign relevant key codes to touch switches.

Error date and time Comment

Jun. 1, 2013 Motor error
Jun. 1, 2013

12:10
14:25 Temperature anomaly

The occurrence date (Jun. 1, 2013) of 
the selected alarm event is written to devices.

D200:   0601h

D201:   2013h

Touch switch Key code Description

Scroll up by one line
00F2h

Switches the display between one row above and one row below.

Scroll down by one line
00F3h

Touch switches for the alarm display (user) Touch switches for the alarm display (system)

Scroll down one row.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

Jun. 1, 2013
Error date and time Restored Checked

15:20
Comment
Fuse error

Alarm status
Occurred

Jun. 1, 2013 11:11 Motor error Occurred

15:10Jun. 1, 2013 14:25 Oil error Checked 14:50
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Show cursor
FFB0h

Displays or deletes the cursor.

Hide cursor
FFB1h

Move cursor upward
FFB2h

• When the cursor is hidden
Displays the previous page or next page by page.

• While the cursor is displayed
Moves the cursor upward or downward by row.

Move cursor downward
FFB3h

Change the selected alarm 
status to "Checked" 
(Check) FFB4h

Changes the alarm status to "Checked".

Change all the alarm 
statuses to "Checked" 
(Check all) FFB5h

Touch switch Key code Description

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The cursor is shown.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The cursor is moved.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

12:23
13:54 Fuel error

Comment

Internal pressure error
Restored

Alarm status

Checked

14:00

Jun. 1, 2013 11:11 Motor error Occurred

13:15

The next page is displayed.

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
Jun. 1, 2013 14:25 Oil error Occurred

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
Jun. 1, 2013 14:25 Oil error Checked 14:50

The alarm status is changed to "Checked".
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Delete the selected 
restored alarm (Delete)

FFB6h

Deletes a selected alarm event or all alarm events in the "Restored" status.

Delete all the restored 
alarms (Delete all)

FFB7h

Display detail

FFB8h

Only available to the alarm display (user).
Displays the detail screen of a selected alarm when this cursor is touched with basic alarms 
displayed.

Move to the lower hierarchy

Only available to the alarm display (user).
Displays the alarms at lower levels in the hierarchy when this cursor is touched with upper alarms 
or middle alarms displayed.

Touch switch Key code Description

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Restored

Alarm status

Occurred
Jun. 1, 2013 14:25 Oil error Checked

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

14:25
15:20 Fuse error

Comment

Oil error
Occurred

Alarm status

Checked 14:50

14:50

The alarm event in the "Restored" status is deleted.

17:15

15:10

15:10

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
Jun. 1, 2013 14:25 Oil error Checked

Jun. 1, 2013
Jun. 1, 2013

15:20
16:51 Temperature anomaly

Fuse error
Occurred
Occurred

Jun. 1, 2013 14:25 Oil error Checked

Error date and time Restored CheckedComment Alarm status

14:50

14:50

The detail screen is displayed.

15:10

15:10

A temperature anomaly 
has occurred in the 
power supply unit. 
Check the power 
supply unit.

-
-

Error date and time Restored Checked

Power supply unit error

Comment

Drive module error

Alarm status

-
-

-
-

-
-

Jun. 1, 2013
Jun. 1, 2013

15:20
16:51 Temperature anomaly

Fuse error
Occurred
Occurred

Error date and time Restored CheckedComment Alarm status

The alarms at the lower level in the hierarchy are displayed.
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Reset the selected alarm 
data

FFB9h

Resets the selected alarm.

To use this touch switch for the alarm display (user), satisfy all the following conditions.
• [Reset] is set on the [Device] tab in the [User Alarm Observation] dialog.

➟9.1.2 ■7 (2) [Device] tab
• Basic-level alarm events are displayed on the object.

Display ladder (Sequence 
Program Monitor (iQ-R/iQ-L 
Ladder))

FFBAh

Only available to the alarm display (user).
Set [Ladder Search Setting] on the [Extended] tab in the [User Alarm Observation] dialog.

➟9.1.2 ■7 (4) [Extended] tab
Performs the coil search or factor search through the specified program file for the device that is 
set for the selected alarm event.
The hit is displayed on the ladder monitor screen.
(One-touch ladder jump function)

Display ladder (Sequence 
Program Monitor (Ladder)) FFBDh

Display ladder (Sequence 
Program Monitor (iQ-F  
Ladder))

FFC3h

Saves the alarm details to 
the data storage.

FFBBh

Saves alarm events to an alarm log file in the data storage.

Touch switch Key code Description

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
Jun. 1, 2013 14:25 Oil error Checked

Jun. 1, 2013
Jun. 1, 2013

15:20
16:51 Temperature anomaly

Fuse error
Restored
Occurred

Jun. 1, 2013 14:25 Oil error Checked

Error date and time Restored CheckedComment Alarm status

14:50

14:50

The selected alarm is reset.

15:10

15:10

17:11

Jun. 1, 2013

Error date and time Restored Checked

15:20

Comment

Fuse error

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The ladder diagram is displayed.

Jun. 1, 2013 16:51 Temperature anomaly Occurred

M999
MOV     1     D1

MOV     2     D2

Jun. 1, 2013
Jun. 1, 2013

Error date and time Restored Checked

15:20
16:51 Temperature anomaly

Comment

Fuse error
Occurred

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The alarm data is stored in the data storage.
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(12)SRAM power-failure backup function
This function saves the logging data collected in the buffering area to the SRAM user area. The logging data saved in the 
SRAM user area is retained even at power failure. Saving data to the SRAM user area for backup at power failure can 
be used for the following functions.
• User alarm observation
• System alarm observation
• Logging function
To use the logging data as a file, configure the setting for the file save and power-failure backup to the SRAM user area.

Display ladder
FFBCh

Only available to the alarm display (user).
Set [Ladder Search Setting] on the [Extended] tab in the [User Alarm Observation] dialog.

➟9.1.2 ■7 (4) [Extended] tab
Performs the coil search or factor search through the specified program file for the device that is 
set for the selected alarm event.
The hit is displayed on one of the following screens.
• Ladder monitor screen of the FX ladder monitor
• Ladder monitor screen of the sequence program monitor (Ladder)
(One-touch ladder jump function)

Move to the upper hierarchy
FFC2h

Only available to the alarm display (user).
Switches the middle or basic level to the upper level in the alarm hierarchy.

Move display position to the 
specified time

FFBEh

Displays the time specified with the display position time device.
(Time specification jump function)
Set [Display Position Time Device] on the [Extended] tab.

➟9.1.5 ■4 (5) [Extended] tab
9.1.5 ■5 (5) [Extended] tab

Display first alarm FFBFh
Returns to the top of the list.
The cursor becomes invisible.
Returns to the top of the list sorted in the specified order.

Touch switch Key code Description

Jun. 1, 2013

Error date and time Restored Checked

15:20

Comment

Fuse error

Alarm status

Occurred
15:10Jun. 1, 2013 14:25 Oil error Checked 14:50

The ladder diagram is displayed.

Jun. 1, 2013 16:51 Temperature anomaly Occurred

M999
MOV     1     D1

MOV     2     D2

-
-

Error date and time Restored Checked

Power supply unit error

Comment

Drive module error

Alarm status

-
-

-
-

-
-

Jun. 1, 2013
Jun. 1, 2013

15:20
16:51 Temperature anomaly

Fuse error
Occurred
Occurred

Error date and time Restored CheckedComment Alarm status

The alarms at the upper level in the hierarchy are displayed.
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(13)Saving data to the SRAM user area
When logging data is collected to the buffering area, the logging data is also saved to the SRAM user area. This saving 
timing cannot be changed.
When the SRAM user area has logging data, the logging data is automatically read when the GOT is powered on.

(14)Specifications of the SRAM user area
For the specifications of the SRAM user area, refer to the following.

➟12.12 Specifications of the SRAM user area

(15)Deleting and backing up the data in the SRAM user area
The data saved in the SRAM user area is deleted under the following conditions.
• Project data and system applications are written to the GOT when [Initialize SRAM user area when writing project data/
OS] is selected in the [Communicate with GOT] dialog.

• The SRAM user area is initialized by using [SRAM management] in the utility.
• The clear trigger device set in [Buffering] of the user alarm observation setting or the system alarm observation setting 
turns on.

• The SRAM user area is set to be initialized when GT SoftGOT2000 starts the first monitoring.
To retain the data saved in the SRAM user area, execute the backup/restoration function in the utility.
For the details of the backup/restoration function, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(16)Precautions for using the SRAM user area
Data may not be saved into the SRAM user area due to some reasons, including the setting change of an applicable 
function and physical memory corruption.

(a) Normal conditions
The data collected by each applicable function is saved to the SRAM user area.

(b) Setting change
If the size of data to be collected by the user alarm observation, system alarm observation, or logging function is changed, 
the data of the function saved in the SRAM user area will be deleted.

• When the size is reduced:
The data is saved to the initialized area. The remaining area is reserved as a free area.

• When the size is increased:
The area used is initialized and the data is saved to another area.
If the area required for saving the data is insufficient, an error occurs.
If an error occurs, initialize the SRAM user area, reduce the data size to 500 KB or less, and save the data 
again.

Logging data

Logging data

Operation memory (RAM)

SRAM

Buffering area

SRAM user area

When the trigger condition of the 
controller is satisfied, logging data 
is collected to the buffering area.

GOT

The logging data collected in the buffering area is saved 
to the SRAM user area for power-failure backup.

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

Details of the SRAM 
user area

500KB

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
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Example) When the size for ID 1 is increased from 100 KB to 200 KB

(c) Setting deletion
When the setting of each function is deleted, the SRAM user area used for saving the data is reserved as an unused area.
Initialize the unused area to use it.
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)
Example) When the setting of ID 1 is deleted

(d) Others
If the data saved in the SRAM user area is not restored at the GOT startup, a system alarm occurs.
In such a case, check the battery status.

• When the battery status is normal:
A part of the SRAM user area may be damaged.
Initialize the SRAM user area.

➟GOT2000 Series User's Manual (Utility)
• When the voltage is low:

Replace the battery.
If the data is still not restored after the battery is replaced, initialize the SRAM user area.
For information on how to replace the battery, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)

■3 Precautions

The following shows the precautions for the alarm display.

(1) Precautions for drawing
(a) Initial display hierarchy and hierarchy switching device

In the alarm display (user) and alarm popup display, the level in the hierarchy specified in [Initial Display Hierarchy] is written 
into the hierarchy switching device with the following timing.
The level in the hierarchy to be displayed is switched.

• When switching screens (alarm display (user) only)
• At the first display of objects
• When the alarm observation ID number to be displayed is switched with the switching device for user alarm 

observation ID
For the setting of [Initial Display Hierarchy], refer to the following.

➟9.1.4 ■4 (1) [Basic] tab
For the setting of the switching devices for levels in the hierarchy and user alarm ID, refer to the following.

➟9.1.4 ■4 (3) [Extended] tab

(b) Switching comment displays or others with the hierarchy switching device
The leftmost bit of the hierarchy switching device changes to 1 by touch operations. Use mask processing and mask the 
device with 7FFFh so that the leftmost bit is always masked to 0.
Comment displays and others cannot work normally without mask processing.

ID2: 100KB
ID3: 200KB

Free area

Free areaID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area is initialized.
In this case, ID 1 cannot be saved 
to another area, and an error occurs.
The initialized area becomes a free area.

Reserved area
ID2: 100KB
ID3: 200KB

Free area

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area for ID 1 becomes 
a reserved area.
By setting the setting of ID 1, the saved 
data can be retained for other use.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Example) When switching comments to be displayed with the value of the hierarchy switching device

• With mask processing

Hierarchy switching device value Corresponding comment Comment to be displayed

0 0 Basic alarm on display

1 1 Middle alarm on display

2 2 Upper alarm on display

Error date and time Comment

-                - An error has occurred in line2.

-                - An error has occurred in line1.

Upper alarm on display

Error date and time Comment

-                - An error occurs in the device B.

-                - An error occurs in the device A.

Middle alarm on display

111111111111110 1

100000000000000 0

100000000000001 0

000000000000000 1

Displays the comment of comment No.2 
because the hierarchy switching device value is 2.

Hierarchy switching device value 2

Hierarchy switching device value 1

AND
Mask value (7FFFh)

Switch from the upper 
to the middle by touching.

Displays the comment of comment No.1 
because the hierarchy switching device value is 1.

Mask processing

Touch
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• Without mask processing

(c) Text display in the row where the cursor is inserted
If the text color of the target set in [Target] in [Text] tab of the [Alarm Display] dialog is set to black, the text color and cursor 
color are shown in the same color, and the text in the row where the cursor is inserted becomes invisible.
To display the text in the row where the cursor is inserted, set a color other than black.

(d) Number of settings
The set size of an object cannot exceed the user area of the GOT.
Therefore, not all the setting values such as device values can be set to their maximum values.
Set the setting values within the capacity of the available user area for the GOT.
For the calculation method of the setting size of the alarm display, refer to the following.

➟1.2.3 ■3 Functions arrangeable on the screen
For the capacity of the available user area for the GOT, refer to the following.

➟12.10.1 Data transferred to the GOT and capacity of the destination drive

(e) User ID assigned to key code switches
When you place an alarm display object on the screen editor, the relevant key code switches are placed together.
The user ID of the alarm display object is automatically assigned to each key code switch ([User ID for a key input]).
If you change the user ID of the alarm display object, also change the set value of [User ID for a key input] for each switch.
Otherwise, the alarm display object is inoperable using the switches.

➟8.2.11 [Key Code Switch] dialog

(f) Settings of a touch switch
If the key cord (FFB5h) to change all the alarm statuses to "Checked" (Check all) is set with any of the following key cords, 
the key cord (FFB5h) becomes inoperable.

• 00F2 (Scrolls up one row)
• 00F3 (Scrolls down one row)
• FFBF (Displays the first alarm)

(2) Precautions for use
(a) Display of the time of occurrence, confirmation, and restoration

For the time of occurrences, the clock data of the GOT is used.
For the precautions and restrictions of the clock function which manages the GOT clock data, refer to the following.

➟5.3 Setting the Utility Function ([GOT Setup])

(b) Narrowing down the large number of monitored alarms
If the number of alarms is narrowed down when the number of monitored devices are large in the user alarm observation, 

Error date and time Comment

-               - An error has occurred in line2.

-               - An error has occurred in line1.

Upper alarm on display

Error date and time Comment

-                - An error occurs in the device B.

-                - An error occurs in the device A.

000000000000000 1

Displays the comment of comment No.2 
because the hierarchy switching device value is 2.

Hierarchy switching device value 2

Switch from the upper 
to the middle by touching.

100000000000001 0 Hierarchy switching device value -32767

Comments are not displayed normally 
because the most significant bit becomes 1 
and thus becomes -32767.

Touch
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displaying the alarms may require a few seconds.
➟9.1.3 ■2 (7) Useful operations and functions

(c) Order of priority in which alarms are displayed
When the display order is not changed in the setting for [Switching Device] in the [Text] tab of the [Alarm Display] dialog, 
alarms are displayed in the descending order of the date and time of occurrences.
When the display order is changed, alarms are displayed in the order set in [Switching Device].

(d) Alarm display for using the set overlay screen function
When setting the overlay screen function to display a screen for which the alarm display is set, do not set the alarm display 
for the basic screen.
If the alarm display is set for the basic screen, alarms are not displayed on the called screen.
For how to set the set overlay screen function, refer to the following.

➟6.6.7 ■5 [Overlay Screen]

(e) Precautions for the use of the time specification jump function
• When carrying out another operation while a time specification jump is performed

While the data obtained at a specified time is searched with the time specification jump function, the operations with 
functions other than the alarm display cannot be performed.

• When multiple values of alarm data are obtained around a specified time
If alarm data are not obtained at a specified time, the data obtained at the nearest time is searched.
When the multiple values are obtained at the nearest time, the first detected value is displayed.

• When displaying the alarm data obtained at the start of collecting the data and the data obtained around the time 
when the latest data is obtained
When the alarm data obtained at a specified time is the one obtained at the start of the collecting the data or the data 
obtained around the time when the latest data is obtained, the data to be displayed may not be displayed in the center 
of the alarm display.

• When there is no alarm data that can be displayed in alarm displays
When there is no alarm data that can be displayed in an alarm display, no time specification jump is performed.

• Levels in the alarm hierarchy available for the time specification jump function
Only the basic alarm is available for the time specification jump function.
The middle alarm and upper alarm are unavailable for the time specification jump function.

■4 [Alarm Display(User)] dialog

Step 1 Select [Object] → [Alarm Display] → [Alarm Display (User)] from the menu.
Step 2 Click the position where you place the alarm display. Placing the alarm display is complete.
Step 3 Double-click the alarm display which has been placed to display the setting dialog.

➟(1) [Alarm Setting] tab
(2) [Display] tab
(3) [Text] tab
(4) [Style] tab
(5) [Extended] tab
(6) [Trigger] tab
(7) [External Output] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) [Alarm Setting] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Configure the settings such as the type of the alarm observation to be displayed, the display method of the message, and 
the operation performed when the alarm display is touched.

1) [Display Alarm]
Select the alarm type to be displayed in the alarm display.
The following shows selectable items.

• [User Alarm]: Displays user alarms.
• [System Alarm]: Displays system alarms.(Not available to GT21 and GS21)

For the alarm display (user), select [User Alarm].
2) [Alarm ID]

Set the alarm ID of the user alarm to be displayed.

3) [Number of Display Rows]
Set the number of rows displayed in a screen.
The following shows the setting range.

• [1] to [64] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [1] to [27] (GT21 and GS21)

Example) When [Number of Display Rows] is set to three rows

Item Description

[Fixed]

Enter the alarm ID directly. 
The setting range is [1] to [32767]. 
Click the [Edit] button to display the [User Alarm Observation] dialog.
➟9.1.2 ■7 [User Alarm Observation] dialog

[Device]
Set the device that specifies the alarm ID.
➟6.1.2 How to set devices
If a nonexistent alarm ID is specified, user alarms are not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

5)
6)
8)

10)

9)

11)

12)

7)

4)

Error date and time Comment Restored Checked
Jun. 1, 2013 10:25 Temperature anomaly 11:25 10:45
Jun. 1, 2013 12:05 Fuel error 12:25

09:45

12:28

Jun. 1, 2013 08:30 Motor error 09:40

Alarms are displayed for three rows 
excluding the title row.
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4) [Display Start Row]
Select a row to be displayed in the top row when the number of alarms exceeds the number of rows set in [Number of 
Display Rows].

• When the number of alarms is larger than the value set in [Display Start Row]
The alarm corresponding to the row number set in [Display Start Row] is displayed in the top row.
Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 2, and the number of alarms is 5

• When the number of alarms is smaller than the value set in [Display Start Row]
The last alarm is displayed in the bottom row.
Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 10, and the number of alarms is 5

• When the number of alarms is smaller than the value set in [Number of Display Rows]
The setting for [Display Start Row] becomes disabled, and all the alarms that have occurred are displayed.
Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 3, and the number of alarms is 2

• Using the setting for multiple screens
When different values of [Display Start Row] are set for each screen, the user alarm displays differ depending on 
the screens.

Item Description

[Fixed] Enter the number of rows to be displayed directly. 
The setting range is [1] to [32767].

[Device]
Set the device that specifies the start row.

➟6.1.2 How to set devices

Error date and time Comment
Jun. 1, 2013 17:00 Fuse error
Jun. 1, 2013 16:51 Oil error

Jun. 1, 2013 15:20 Fuel error

Generated alarms

1. Temperature anomaly
2. Fuse error
3. Oil error
4. Fuel error
5. Internal pressure error

The alarm corresponding to the row number set 
in [Display Start Row] is displayed in the top row.

Display 
order of 
alarms

Error date and time Comment
Jun. 1, 2013 16:51 Oil error
Jun. 1, 2013 15:20 Fuel error

Jun. 1, 2013 14:25 Internal pressure error

Generated alarms

1. Temperature anomaly
2. Fuse error
3. Oil error
4. Fuel error
5. Internal pressure 
    error

The last alarm is displayed in the bottom row.

Display 
order of 
alarms

Error date and time Comment
Jun. 1, 2013 17:00 Temperature anomaly
Jun. 1, 2013 16:51 Fuse error

Generated alarms

1. Temperature anomaly
2. Fuse error

All the alarms that have occurred are displayed.

Display 
order of 
alarms
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Even if the number of alarms exceeds the value set in [Display Start Row] when user alarms are displayed on the GOT, 
the setting for [Display Start Row] does not become enabled.
To enable the setting for [Display Start Row], switch the screen to another one, then switch back the screen to the one 
in which the user alarm is displayed.

5) [Display Target]
Select the display method of collected alarms.
The following shows selectable items.

• [All Alarm]:
Select this item to display the history of alarms including the past alarms.

• [Generating Alarm]:
When this item is set, only the existing alarms are displayed.

➟9.1.5 ■1 (2) Alarm events to be listed
6) [Display Type]

Select the display method of the comments for alarms.
The following shows selectable items.

• [Fixed]:
Does not scroll a comment displayed at an alarm occurrence.
When a comment extends off the display area, the part outside the area and the second and subsequent rows are 
not displayed.

• [Flow all]:
Scrolls a full comment displayed at an alarm occurrence from right to left.

• [Flow as required]:
Does not scroll a comment fully displayed within the display area.
Scrolls a comment extending off the display area and a multiple-row comment from right to left.

• [Flow the selected row]:
Scrolls only the comment selected among the comments displayed at an alarm occurrence from right to left.

➟9.1.5 ■2 (2) Display method of comments
Scrolling a comment is available for up to 16 alarm display objects including Alarm Display (User) and Alarm Display 
(System) on one screen.
If scrolling a comment is set for 17 alarm display objects or more, comment display on the 17th object and later are 
fixed.

7) [Speed]
This item is settable when [Display Type] is set to [Flow all], [Flow as required], or [Flow the selected row].
Set the speed at which the display is scrolled.
The following shows selectable items.

• [High]: The text of comments flows at the speed of 200 dots a second.
• [Medium]: The text of comments flows at the speed of 100 dots a second.
• [Low]: The text of comments flows at the speed of 50 dots a second.

8) [Initial Display Hierarchy]
Select a level in the alarm hierarchy to be displayed first when a user alarm occurs.
The following shows selectable items.

• [Basic]
• [Middle]

1st
2nd
3rd

4th
5th
6th

7th
8th
9th

Number of alarms

2nd
3rd

1st

5th
6th

4th

8th
9th

7th

Screen 1
Display start row: 1

Screen 2
Display start row: 4

Screen 3
Display start row: 7
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• [Upper]
9) [Touch Mode]

Select the operation performed when the alarm display (user) is touched.
The following shows selectable items.

• [None]:
Select this item to disable touch operations.

• [Selection]:
Selects a touched alarm.

• [Operation]:
Selects a touched alarm.
Switches between levels in the alarm hierarchy with each touch of the selected alarm.
Touching a selected upper alarm displays the middle alarm.
Touching a selected middle alarm displays the basic alarm.
Touching a selected basic alarm displays the detail screen.
While GS450.b15 is on, even when a basic alarm is not selected, a single touch of the basic alarm displays the 

detail screen.
10) [Detail No. Offset]

Select this item to switch detailed information displayed in the user alarm according to the value of a device.
The device value is added to the detail No.

11) [Comment No. Offset]
Select this item to switch comments displayed in the user alarm according to the value of a device.
The set device value is added to the comment No.

12) [Name]
Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

(2) [Display] tab

Set the items to be displayed in the user alarm and the display order.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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1) [Title]

2) [Contents]

Item Description

[Specification]

Select the method of specifying the text to be displayed in the title.
The following shows selectable items.
• [Direct]:

Select this item to input the text to be displayed in the title directly into [Title] in [Contents].
• [Comment]:

Select this item to display the text to be displayed in the title using the comment in the 
comment group.

• [None]:
Select this item not to display the title.

[Group No.]
Only when [Comment] is selected for [Specification], this item can be set.
Set the comment group in which the text to be displayed in the title is registered.

[Adjust Text Size]
Only when [Comment] is selected for [Specification], this item can be set.
The text size is adjusted according to the width of the title.
When [Adjust Text Size] is not selected, the text size is adjusted by inserting a line feed.

[Minimum Size]

Only when [Comment] is selected for [Specification] and [Adjust Text Size] is selected, this 
item can be set.
Set the minimum text size for adjustment.
The setting range is [8] to [240] dot(s).

Item Description

[Display] Select the items to be displayed in the alarm display (user).

[Attribute]

Items to be displayed in the alarm display (user)
• [Occurred]: Displays the date and time of occurrence of an alarm.
• [Comment]: Displays the date and time of occurrence of an alarm.
• [Status]: Displays the alarm status.
• [Restored]: Displays the date and time when an alarm has restored.
• [Checked]: Displays the date and time when an alarm occurrence has been checked.
• [Frequency]: Displays the number of error occurrence.
• [Cumulative Time]: Displays the total time during which the relevant alarm has occurred.
• [Down Time]: Displays the time from the alarm occurrence to the alarm restoration.
• [Level]: Displays the levels set for alarms.
• [Group]: Displays the groups set for alarms.
When any item other than [Cumulative] is selected for [Collection Mode] in the [Basic] tab 
of [User Alarm Observation], the data of [Frequency], [Cumulative Time], and [Down Time] 
will not be displayed.

[Digits]

Set the number of the digits displayed in each item.
Set a one-byte character as one digit and a two-byte character as two digits.
The following shows the setting range of each item.
• [Occurred]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].
• [Comment]: [10] digits to [128] digits (For GT21 and GS21: [10] digits to [80] digits)
• [Status]: [6] digits to [128] digits (For GT21 and GS21: [6] digits to [80] digits)
• [Restored]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].
• [Checked]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].
• [Frequency]: [5] digits to [128] digits (For GT21 and GS21: [5] digits to [80] digits)
• [Cumulative Time]: [8] digits to [128] digits (For GT21 and GS21: [8] digits to [80] digits)
• [Down Time]: [8] digits to [128] digits (For GT21 and GS21: [8] digits to [80] digits)
• [Level]: [3] digits to [128] digits (For GT21 and GS21: [3] digits to [80] digits)
• [Group]: [3] digits to [128] digits (For GT21 and GS21: [3] digits to [80] digits)

[Title]

Set a title of the alarm display (user).
The setting depends on the value selected for [Specification].
When [Direct] is selected, input characters within the number of digits set in [Digits].
When [Comment] is selected, the comment No. and the comment to be displayed in the 
title are displayed.
When [None] is selected, the title cannot be set.

[Date/Time Format]

Set the date and time format for each attribute item.
The setting method varies by attribute item.
For [Occurred], [Restored], and [Checked], click the [...] button to set the date and time 
format in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings
For [Cumulative Time] and [Down Time], select a time format of hours:minutes or 
hours:minutes:seconds.
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3) [Display Order]
Set the order in which the items set for [Attribute] in [Contents] are displayed.
The items of [Attribute] which are set in [Display] are displayed.
Move the display position of the selected item sideways by using the right button and the left button.

Right button
Left button

Selected item

Moves to the left.

Click the right button.

Click the left button.

Moves to the right.
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(3) [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the font of displayed alarms.

1) [Font]
Select the font of the displayed text.
The following shows selectable items.

• [6x8dot]
• [12dot Standard]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Level] is selected for [Target]

When [Group] is selected for [Target] When [Level + Status] is selected for [Target]

When [Group + Status] is selected for [Target] When [Comment Attribute] is selected for [Target]

When [Status] is selected for [Target]

1)

5)

2)

6)

When [Fixed] is selected for [Target]

3)

4)
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• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline] (GT2107-W and GS21-W-N)

2) [Text Size]
For the details of each font and size, refer to the following.

➟1.2.5 Font specifications
3) [Display the comments in Windows fonts]

Displays the following registered comments in Windows fonts.
• Comments set for the basic alarm comment, upper comment, middle comment, and detail display in the user alarm 

observation
• Comments set for the titles in the [Display] tab (when [Comment] is selected for [Specification])

This setting is deleted when one of the following settings is made.
• [Device] is selected for [Alarm ID] in the [Alarm Setting] tab.
• An item other than [Fixed] is selected for [Display Type] in the [Alarm Setting] tab.
• [Basic Alarm Comment Group], [Middle Comment Group], or [Upper Comment Group] is selected in the [Extended] 

tab.
4) [Windows Font Setting] button

Displays the [Comment Group Property] dialog. (The properties of the comment group used for the basic alarm 
comment are displayed.)
Set Windows fonts to display comments.

➟5.8.4 ■2 (1) [Comment Group Property] dialog
5) [Title Format]

Set the format of the text displayed in the title of the alarm display (user).

Item Description

[Text Color]
Set the text color.

➟6.4 Color Settings

[Style]

Set the style of the text to be displayed. 
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

[Solid Color] When [Solid] or [Raised] is selected for [Style], set the color of the shadow.

[KANJI Region]

Select the KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows selectable items.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

[Solid] button
[Raised] button

[Bold] button
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6) [Table Format]

Item Description

[Switching]

Select how to use different text colors in displaying alarms. 
The following shows selectable items.
• [Fixed]: Displays texts only in the color set as a text color.
• [Status]: Changes the text color for each alarm status.
• [Level]: Changes the text color for each level.
• [Group]: Changes the text color for each group.
• [Level + Status]: Changes the text color for each level and alarm status.
• [Group + Status]: Changes the text color for each group and alarm status.
• [Comment Attribute]: Applies colors of text according to the character attribute set for the 

comment group, and displays the comments.

[Style]

Set the style of the text to be displayed. 
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

[Solid Color] When [Solid] or [Raised] is selected for [Style], set the color of the shadow.

[Fixed] When [Fixed] is selected for [Switching], set the text color.

[Occurred] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm occurs.

[Restored] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm is restored.

[Checked (Occurrence)] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm occurrence is checked.

[Checked (Restoration)] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm restoration is checked.

[Level Color] When [Level] or [Level + Status] is selected for [Switching], set the text color for the level.

[Group Color] When [Group] or [Group + Status] is selected for [Switching], set the text color for the 
group.

[Text Color (Upper)] When selecting [Level], [Group], [Level + Status], or [Group + Status] for [Switching], set 
the text color for alarms displayed at the upper level in the hierarchy.

[Text Color (Middle)] When selecting [Level], [Group], [Level + Status], or [Group + Status] for [Switching], set 
the text color for alarms displayed at the middle level in the hierarchy.

[Solid] button
[Raised] button

[Bold] button
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(4) [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the ruled line and shape of the alarm display (user).

1) [Draw Ruled Line]

2) [Display Format]

Item Description

[Line Style] Select the type of the ruled line of the alarm display (user).

[Line Width] Select the width of the ruled line of the alarm display (user).

[Line Color] Select the color of the ruled line of the alarm display (user).

Item Description

[Sort]

Select an item and a method for sorting the display of user alarms.
• For [Occurred], [Restored], and [Checked], the sorting order can be selected from 

[Reverse chronological] or [Chronological].
• For [Comment], [Frequency], [Cumulative Time], [Down Time], [Level], [Group], and 

[Observation Alarm No.], the sorting order can be selected from [Ascending] or 
[Descending].

• For [Status], the sorting order can be selected from [Checked->Restored->Occurred] or 
[Occurred->Restored->Checked].

[Space]

Set the space between the text to be displayed and the line.
• [X]:

Set the space in 1 dot unit.
The setting range is [0] to [32].

• [Y]:
Set the space in 1 dot unit.
The setting range is [0] to [32].

[Cursor Color] Set the cursor color for selecting a user alarm.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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3) [Shape Settings]

(5) [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the operation of switching displays for the alarm display (user) by devices.

1) Security level
Set the security level of display and operation.

[Text color on cursor display]

Method to set the color of text on the cursor.
• [XOR]

Displays the text in the synthesized color with XOR specification.
• [Reverse]

Inverts the text.

As the setting is fixed to [XOR], no additional setting is required accordingly.

The following shows the items to be selected.
• [XOR]
• [Reverse]

Item Description

[Shape]
Set a shape for the alarm display (user).
To select a shape other than those in the list box, click the [Shape] button.

[Frame Color] Set the frame color of the shape.

[Shape Color] Set the color of the shape.

Item Description

GOT Graphic Ver.2

GOT Graphic Ver.1

Item Description

[Display]
Set the security level of display. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security.

[Operation]

Set the security level of operation. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security. 
The setting of security level of [Operation] must be set to the one exceeding the security 
level of [Display].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

4)

5)

6) 7)
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2) [User ID]
Set the user ID of the alarm display (user).
If an alarm display (user) and another alarm display are set on a screen, touch switches for the alarm display (user) 
may not function.
For secure operations of the touch switches for alarm displays (user), set user ID for the alarm displays (user).

➟9.1.5 ■2 How to use the alarm display
3) [Operation Log Target]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select this item to target the object for the operation log.

➟5.2.11 ■1 Specifications of the operation log
4) [Switching Device]

Select items to switch the display using devices.
➟9.1.5 ■2 How to use the alarm display

Item Description

[Hierarchy]

Switches the level in the alarm hierarchy to be displayed using the device value. 
All the user alarms at the specified level in the alarm hierarchy are displayed. 
Set the switching device.

➟6.1.2 How to set devices
Store values to the device as follows to switch the level in the alarm hierarchy.

• With b1 to b0, specify the target level in the user alarm hierarchy for switching.
00 (0): Basic alarm
01 (1): Middle alarm
10 (2): Upper alarm

• Using b14 to b2 is prohibited.
• To b15, store the type of operations of switching levels in the hierarchy. (Identifier of hierarchy switching 

controllers)
To switch levels in the hierarchy using the hierarchy switching device, always set 0 to this bit.
0: Switching by using the switching device
1: Switching by touching the display part

For the precautions of switching the comment display or other items using devices, refer to the following.
➟9.1.4 ■3 Precautions

[Level]

Only the user alarms with a specified level No. are displayed. 
Set the switching device.

➟6.1.2 How to set devices
Store the level No. of user alarms to be displayed to the device.
• To display a specific level, specify a level No. within 1 to 255.
• If a nonexistent level No. is specified, user alarms are not displayed.
• To display all levels, specify the level No. 0 or a No. over 256.

[Group]

Only the user alarms with a specified group No. are displayed. 
Set the switching device.

➟6.1.2 How to set devices
Store the group No. of user alarms to be displayed to the device.
• To display a specific group, specify a group No. within 1 to 255.
• If a nonexistent group No is specified, alarms are not displayed.
• To display all groups, specify the group No. 0 or a No. over 256.

b14 to b2 b1 b0b15
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[Priority Display Attribute]

Switch the item to be the sort criteria according to the device values. 
Set the switching device.

➟6.1.2 How to set devices
Store values to the device to switch the order of alarm display.

• b0 to b3:
Specify the sort criteria.
□000h: Normal (date and time of occurrence)
□001h: Date and time of occurrence
□002h: Date and time of restoration
□003h: Date and time of confirmation
□004h: Comment No.
□005h: Level
□006h: Group
□007h: Alarm status
□009h: Frequency
□00Ah: Cumulative time
□00Bh: Down time
□00Ch: Monitored alarm No.

• b4 to b14:
Using these bits is prohibited.

• b15:
Specifies the ascending or descending order.
000□h: Descending
800□h: Ascending

The date and time of occurrence, cumulative time, and down time can be set only when the collection 
mode in the user alarm observation is [Cumulative]. 
If a value other than the above is stored, alarms are displayed in the order of the date and time of 
occurrence.

[Basic Alarm Comment Group]

Switch the comment group to be displayed in the basic alarm according to the device values. 
Set the switching device.

➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in the user alarm 

observation.
• When a nonexistent comment group No. is specified, No message is displayed.

[Middle Alarm Comment Group]

Switch the comment group to be displayed in the middle alarm according to the device values. 
Set the switching device.

➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in the user alarm 

observation.
• When a nonexistent comment group No. is specified, No message is displayed.

[Upper Alarm Comment Group]

Switch the comment group to be displayed in the upper alarm according to the device values. 
Set the switching device.

➟6.1.2 How to set devices
• If 0 is stored to the device, alarms are displayed with the comment group which is set in the user alarm 

observation.
• When a nonexistent comment group No. is specified, No message is displayed.

Item Description

b14 to b4 b2b3b15 b1 b0
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5) [Display Position Time Device]

*1 Place the following objects on the screen and set them.

6) [Layer]
Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows selectable items.

• [Front]
• [Back]

Item Description

[Display Position Time]

Displays the data of a specified time. (Time specification jump function) 
Set a device in which a specified time is stored.

➟6.1.2 How to set devices
The successive devices from a set device are set to store the data of year and month, day and hour, and 
minute and second. 
By using the display position time device and a touch switch, the basic alarm or a specified time is 
displayed. 
If alarm data are not obtained at a specified time, the data obtained at the nearest time is displayed.
• Time specification jump function of when [Priority Display Attribute] is set

Alarms are displayed in the order set in [Priority Display Attribute].
The display order is "Restored", "Checked", and "Occurred".
When [Priority Display Attribute] is not set, alarms in a specified time are displayed regardless of the 
above order.

• Specification of the time which can be set
The data type is BCD16 (binary coded decimal).
The data range varies with the GOT model.
GT27, GT25, GT23, and GS25: Jan. 1, 2000 to Dec. 31, 2099
GT21 and GS21: Jan. 1, 2000 to Dec. 31, 2037

• Required settings*1

• Operation example
The following shows an example of a time specification jump function operation.
Example) When setting D1000 as the display position time specification device and displaying the data 
of Jun.1, 2013 21:05:30

For precautions of the time specification jump function, refer to the following.
➟9.1.5 ■1 Specifications of the alarm display

Object Settings

Switch, key code switch

Read an applicable object from the library of GT Designer3, or create it.
➟9.1.5 ■2 How to use the alarm display

When creating the objects, set [Action] of [Code Setting] to [Display Position Time Device] 
for each object.

➟8.2 Placing a Touch Switch

Alarm display (user)
Select [Display Position Time] in the [Extended] tab and set a device.

➟9.1.5 ■4 (5) [Extended] tab

Alarm display (system)
Select [Display Position Time] in the [Extended] tab and set a device.

➟9.1.5 ■5 (5) [Extended] tab

Display position time device
H L

Year and month 
(D1000)

15 bits 8 bits 7 bits

0x13

0x01

0x05

0x06

0x21

0x30

0 bit

Day and time 
(D1001)
Minute and 
second (D1002)

Set the time to be displayed 
in the display position time device.

Touch the touch switch for which 
the key code (FFBEh) has been set.

Error date and time Comment Restored Checked
Jun. 1, 2013 21:05:40 Motor error

Jun. 1, 2013 10:25 Oil pressure error 21:40:30 21:35:45
Jun. 1, 2013 21:05:30 Light error 21:35:45

The data obtained at the specified time 
(Jun. 1, 2013 21:05:30) is displayed.
9 - 134 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

➟6.5.5 ■3 Superimposition
7) Category I

Select the category to assign the object.
➟11.7 Managing figures and objects by category

(6) [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.

2) [Trigger Type]
Select the condition of displaying and operating the object.
The following shows selectable items.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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(7) [External Output] tab

Configure the setting for writing the information of the alarm selected in the alarm display (user) into devices.

1) [Enable External Output]
Write the information of touched alarm into devices.

➟9.1.5 ■2 How to use the alarm display
2) [Trigger Type]

Select the timing to write the alarm information into a device.
Select [Ordinary] to write the alarm information into the device when the alarm is touched.
Select [ON] to write the alarm information into the device when the alarm display area is touched while the device is on.
Select [OFF] to write the alarm information into the device when the alarm display is touched while the device is off.

3) [Trigger Device]
When selecting [ON] or [OFF] in [Trigger Type], set the device to be a trigger.

➟6.1.2 How to set devices
4) [When cursor is hidden]

Configure the setting for external outputs of when the cursor is hidden.
• [Clear External Output Device]:

Select this item to clear the value of the external output device when no alarm is selected.
• [Output alarm information of the top row]:

Select this item to output externally the alarm information displayed at the top row when no alarm is selected.
5) [First Device]

Set the start device (word device) to which the information of the alarm is written.
When items to be written are selected, the successive devices following the start device are automatically set.

Item Description

[Alarm ID] Select this item to write the alarm ID into devices.

[Comment Group No.] Select this item to write the comment group No. of the comment displayed with the alarm 
display.

[Comment No.] Select this item to write the comment No. of the comment displayed with the alarm display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)

5)

6)
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[Status]

Select this item to write the alarm status into devices.

• b0:
When the alarm is in the "Occurred" status, 1 is stored, and when the alarm is in the 
"Restored" status, 0 is stored.

• b1:
When the alarm is in the "Checked" status, 1 is stored, and when the alarm is unchecked, 
0 is stored.

• b2:
When writing the alarm status into devices is enabled, 1 is stored, and when writing the 
alarm status into devices is disabled, 0 is stored.

• b15 to b3:
Using these bits is prohibited.

For the details of the write trigger, refer to the following.
➟9.1.5 ■4 (7) (a) Write trigger

[Occurred Date]

Select this item to write the date when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Occurred Time]

Select this item to write the time when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Restored Date]

Select this item to write the date when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Restored Time]

Select this item to write the time when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Checked Date]

Select this item to write the date when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Checked Time]

Select this item to write the time when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■4 (7) (b) Descriptions of the date and time to be written

[Level]
Select this item to write the level No. of an alarm into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger

[Group]
Select this item to write the group No. of an alarm into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger

[Frequency]
Select this item to write the frequency of alarm occurrences into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger

[Cumulative Time]

Select this item to write the cumulative time of alarms into devices.
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
The cumulative time (in hours and minutes) is stored in BCD code in two word devices.
Example) When the cumulative time is 12 hours and 35 minutes
Device value: 1235

Item Description

b15 to b3 b2 b1 b0
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6) [Display Target Alarm Setting]
Set the devices to which the information on the displayed alarms is written.

(a) Write trigger
• Levels in the alarm hierarchy for which the alarm information can be written

Only when the basic alarm is touched, the alarm information is written into devices.
• Writing by the collection mode

The available data for writing differs according to the collection mode which is set in the alarm observation.
For details, refer to the following.

➟9.1.2 ■1 Specifications of the user alarm observation

(b) Descriptions of the date and time to be written
The date and time are respectively stored in two word devices.
The following describes the case in which the time of occurrence is written into D254 (2 points) and the date of occurrence 
is written into D256 (2 points).

• Date
Store the year, month, and day with BCD code.

• Time
Stores the hour, minute, and second with BCD code.

Example) Jun. 1, 2013 12:24:56

[Down Time]

Select this item to write the down time of alarms into devices.
For the details of the write trigger, refer to the following.

➟9.1.5 ■4 (7) (a) Write trigger
The downtime (in hours and minutes) is stored in BCD code in two word devices.
Example) When the downtime is 2 hours and 10 minutes
Device value: 210

[Select All] button Selects all alarm information.

[Deselect] button Cancels all the selected alarm information.

Item Description

[Active Alarm Status Notification]

Set the device that notifies the status of the displayed alarms. 
The following shows the notification details of each bit.

• b0 to 13:
Using these bits is prohibited.

• b14:
Stores 1 when a value greater than the number of displayed alarms is input to the device, 
which is set for [Display Start Row] on the [Alarm Setting] tab.

• b15:
Using these bits is prohibited.

[Display Target Alarm Number Output] Set the device that stores the number of displayed alarms.

Item Description

b13～ b0b15 b14

D254

D255

Month (1 to 12) Date (1 to 31)

Two upper 
digits of year

Two lower 
digits of year

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

Minute (0 to 59) Second 
(0 to 59)

00 Hour (0 to 23)

b15 to b8 b7 to b0

b15 to b8 b7 to b0
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■5 [Alarm Display(System)] dialog

Step 1 Select [Object] → [Alarm Display] → [Alarm Display (System)] from the menu.
Step 2 Click the position where you place the alarm display. Placing the alarm display is complete.
Step 3 Double-click the alarm display which has been placed to display the setting dialog.

➟(1) [Alarm Setting] tab
(2) [Display] tab
(3) [Text] tab
(4) [Style] tab
(5) [Extended] tab
(6) [Trigger] tab
(7) [External Output] tab

(1) [Alarm Setting] tab

Configure the settings such as the type of the alarm observation to be displayed, the display method of the message, and 
the operation performed when the alarm display is touched.

1) [Display Alarm]
Select the alarm type to be displayed in the alarm display.

D254

D255

06 01

20 13

(Month) (Date)

(Year)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

24 56

00 12

(Minute) (Second)

(Hour)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

5)

7)

8)

9)

6)
4)
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The following shows selectable items.
• [User Alarm]: Select this item to display the user alarm.
• [System Alarm]: Select this item to display the system alarm.

For the alarm display (system), select [System Alarm].
Click the [Edit] button to display the [System Alarm Observation] dialog.

➟9.1.3 ■5 [System Alarm Observation] dialog
2) [Number of Display Rows]

Set the number of rows displayed in a screen.
The following shows the setting range.

• [1] to [64] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [1] to [27] (GT21 and GS21)

Example) When [Number of Display Rows] is set to three rows

3) [Display Start Row]
Select a row to be displayed in the top row when the number of alarms exceeds the number of rows set in [Number of 
Display Rows].

• When the number of alarms is larger than the value set in [Display Start Row]
The alarm corresponding to the row number set in [Display Start Row] is displayed in the top row.
Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 2, and the number of alarms is 5

• When the number of alarms is smaller than the value set in [Display Start Row]
The last alarm is displayed in the bottom row.
Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 10, and the number of alarms is 5

• When the number of alarms is smaller than the value set in [Number of Display Rows]
The setting for [Display Start Row] becomes disabled, and all the alarms that have occurred are displayed.

Item Description

[Fixed] Enter the number of rows to be displayed directly. 
The setting range is [1] to [32767].

[Device]
Set the device that specifies the start row.

➟6.1.2 How to set devices

Error date and time Comment Restored Checked
Jun. 1, 2013 10:25 402 A communication tim 11:25 10:45
Jun. 1, 2013 12:05 70 The battery voltage 12:25

09:45

12:28

Jun. 1, 2013 08:30 460 Communication unit 09:40

Alarms are displayed for 
three rows excluding the title row.

Error date and time Comment
Jun. 1, 2013 17:00 70 The battery voltage 
Jun. 1, 2013 16:51 460 Communication 

Jun. 1, 2013 15:20 803 The transient error 

Generated alarms

1. 402 A communication 
    timeout...
2. 70 The battery voltage 
    became...
3. 460 Communication unit...
4. 803 The transient error 
    has...
5. 500 The GOT built-in 
    battery voltage...

The alarm corresponding to the row number set in 
[Display Start Row] is displayed in the top row.

Display 
order of 
alarms

Error date and time Comment
Jun. 1, 2013 16:51 460 Communication 
Jun. 1, 2013 15:20 803 The transient error

Jun. 1, 2013 14:25 500 The GOT built-in 

Generated alarms

1. 402 A communication 
    timeout...
2. 70 The battery voltage 
    became...
3. 460 Communication unit...
4. 803 The transient error 
    has...
5. 500 The GOT built-in 
    battery voltage...

The last alarm is displayed in the bottom row.

Display 
order of 
alarms
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Example) When [Number of Display Rows] is set to 3, [Display Start Row] is set to 3, and the number of alarms is 2

• Using the setting for multiple screens
When different values of [Display Start Row] are set for each screen, the system alarm displays differ depending 
on the screens.

Even if the number of alarms exceeds the value set in [Display Start Row] when system alarms are displayed on the 
GOT, the setting for [Display Start Row] does not become enabled.
To enable the setting for [Display Start Row], switch the screen to another one, then switch back the screen to the one 
in which the system alarm is displayed.

4) [Display Target]
Select the display method of collected alarms.
The following shows selectable items.

• [All Alarm]:
Select this item to display the history of alarms including the past alarms.

• [Generating Alarm]:
When this item is set, only the existing alarms are displayed.

➟9.1.5 ■1 (2) Alarm events to be listed
5) [Display Type]

Select the display method of the comments for alarms.
The following shows selectable items.

• [Fixed]:
Does not scroll a comment displayed at an alarm occurrence.
When a comment extends off the display area, the part outside the area and the second and subsequent rows are 
not displayed.

• [Flow all]:
Scrolls a full comment displayed at an alarm occurrence from right to left.

• [Flow as required]:
Does not scroll a comment fully displayed within the display area.
Scrolls a comment extending off the display area and a multiple-row comment from right to left.

• [Flow the selected row]:
Scrolls only the comment selected among the comments displayed at an alarm occurrence from right to left.

➟9.1.5 ■2 (2) Display method of comments
Scrolling a comment is available for up to 16 alarm display objects including Alarm Display (User) and Alarm Display 
(System) on one screen.
If scrolling a comment is set for 17 alarm display objects or more, comment display on the 17th object and later are 
fixed.

Error date and time Comment
Jun. 1, 2013 17:00 402 A communication 
Jun. 1, 2013 16:51 70 The battery voltage 

Generated alarms

1. 402 A communication 
    timeout...
2. 70 The battery voltage 
    became...

All the alarms that have occurred are displayed.

Display 
order of 
alarms

1st
2nd
3rd

4th
5th
6th

7th
8th
9th

Number of alarms

2nd
3rd

1st

5th
6th

4th

8th
9th

7th

Screen 1
Display start row: 1

Screen 2
Display start row: 4

Screen 3
Display start row: 7
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6) [Speed]
This item is settable when [Display Type] is set to [Flow all], [Flow as required], or [Flow the selected row].
Set the speed at which the display is scrolled.
The following shows selectable items.

• [High]: The text of comments flows at the speed of 200 dots a second.
• [Medium]: The text of comments flows at the speed of 100 dots a second.
• [Low]: The text of comments flows at the speed of 50 dots a second.

7) [Touch Mode]
Select the operation performed when the alarm display (user) is touched.
The following shows selectable items.

• [None]: Select this item to disable touch operations.
• [Selection]: Select this item to select a touched alarm.

8) [Display detailed information on the target alarm]
Displays detailed information added to system alarms.
This item is enabled only when [Display detailed information on the target alarm] is selected in the [Basic] tab of the 
[System Alarm Observation].
The following shows the detailed information to be added.

• [Channel]
• [Network No.]
• [Station No.]
• [CPU No.]
• [Device]
• [Screen No.]
• [Definition Screen No.]
• [Object ID]
• [Function Name]
• [Drive Name]

[-] is displayed for information which is not related to the alarm or information in which no alarm is detected.
9) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.
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(2) [Display] tab

Set the items to be displayed in the system alarm and the display order.

1) [Title]

2) [Contents]

Item Description

[Specification]

Select the method of specifying the text to be displayed in the title.
The following shows selectable items.
• [Direct]:

Select this item to input the text to be displayed in the title directly into [Title] in [Contents].
• [Comment]:

Select this item to display the text to be displayed in the title using the comment in the 
comment group.

• [None]:
Select this item not to display the title.

[Group No.]
Only when [Comment] is selected for [Specification], this item can be set.
Set the comment group in which the text to be displayed in the title is registered.

[Adjust Text Size]
Only when [Comment] is selected for [Specification], this item can be set.
The text size is adjusted according to the width of the title.
When [Adjust Text Size] is not selected, the text size is adjusted by inserting a line feed.

[Minimum Size]

Only when [Comment] is selected for [Specification] and [Adjust Text Size] is selected, this 
item can be set.
Set the minimum text size for adjustment.
The setting range is [8] to [128] dot(s).

Item Description

[Display] Select the items to be displayed in the alarm display (system).

[Attribute]

Items to be displayed in the alarm display (system)
• [Occurred]: Displays the date and time of occurrence of an alarm.
• [Comment]: Displays the date and time of occurrence of an alarm.
• [Status]: Displays the alarm status.
• [Restored]: Displays the date and time when an alarm has restored.
• [Checked]: Displays the date and time when an alarm occurrence has been checked.
When an option other than [Cumulative] is selected for [Collection Mode] in the [Basic] tab 
of [User Alarm Observation], the item name is displayed, but the value is not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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3) [Display Order]
Set the order in which the items set for [Attribute] in [Contents] are displayed.
The items of [Attribute] which are set in [Display] are displayed.
Move the display position of the selected item sideways by using the right button and the left button.

[Digits]

Set the number of the digits displayed in each item.
Set a one-byte character as one digit and a two-byte character as two digits.
The following shows the setting range of each item.
• [Occurred]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].
• [Comment]: [10] digits to [128] digits (For GT21 and GS21: [10] digits to [80] digits)
• [Status]: [6] digits to [128] digits (For GT21 and GS21: [6] digits to [80] digits)
• [Restored]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].
• [Checked]: The number of digits for this item is automatically set according to the setting 

for [Date/Time Format].

[Title]

Set a title of the alarm display (user).
The setting depends on the value selected for [Specification].
When [Direct] is selected, input characters within the number of digits set in [Digits].
When [Comment] is selected, the comment No. and the comment to be displayed in the 
title are displayed.
When [None] is selected, the title cannot be set.

[Date/Time Format]
Set the display format to display the date and time of occurrence of an alarm.
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings

Item Description

Right button
Left button

Selected item

Moves to the left.

Click the right button.

Click the left button.

Moves to the right.
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(3) [Text] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the font of displayed alarms.

1) [Font]
Select the font of the displayed text.
The following shows selectable items.

• [6x8dot]
• [12dot Standard]
• [16dot Standard Mincho] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard Gothic] (GT27, GT25, GT SoftGOT2000, and GS25)
• [16dot Standard] (GT23, GT21, and GS21)
• [12dot HQ Mincho]
• [12dot HQ Gothic]
• [16dot HQ Mincho]
• [16dot HQ Gothic]
• [Outline Kaisho] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Outline Gothic] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)

2) [Text Size]
For the details of each font and size, refer to the following.

➟1.2.5 Font specifications
3) [Title Format]

Set the format of the text displayed in the title of the alarm display (user).

Item Description

[Text Color]
Set the text color.

➟6.4 Color Settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

4)

When [Fixed] is selected for [Target]

When [Status] is selected for [Target]
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4) [Table Format]

[Style]

Set the style of the text to be displayed. 
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

[Solid Color] When [Solid] or [Raised] is selected for [Style], set the color of the shadow.

[KANJI Region]

Select the KANJI region of the displayed text.
➟1.2.5 Font specifications

The following shows selectable items.
• [Japan]
• [China(GB)-Mincho]
• [China(Big5)-Gothic]

Item Description

[Switching]

Select how to use different text colors in displaying alarms. 
The following shows selectable items.
• [Fixed]: Displays texts only in the color set as a text color.
• [Status]: Changes the text color for each alarm status.

[Style]

Set the style of the text to be displayed. 
One style ([Bold], [Solid], or [Raised]) is settable only.

• [Bold] button
Displays the text in bold.

• [Solid] button
Displays the text with a shadow.

• [Raised] button
Displays the text embossed.

[Solid Color] When [Solid] or [Raised] is selected for [Style], set the color of the shadow.

[Fixed] When [Fixed] is selected for [Switching], set the text color.

[Occurred] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm occurs.

[Restored] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm is restored.

[Checked (Occurrence)] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm occurrence is checked.

[Checked (Restoration)] When one of [Status], [Level + Status], or [Group + Status] is selected for [Switching], set 
the text color of when an alarm restoration is checked.

Item Description

[Solid] button
[Raised] button

[Bold] button

[Solid] button
[Raised] button

[Bold] button
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(4) [Style] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the ruled line and shape of the alarm display (system).

1) [Draw Ruled Line]

2) [Display Format]

Item Description

[Line Style] Select the type of the ruled line of the alarm display (system).

[Line Width] Select the width of the ruled line of the alarm display (system).

[Line Color] Select the color of the ruled line of the alarm display (system).

Item Description

[Sort]

Select an item and a method for sorting the display of user alarms.
• For [Occurred], [Restored], and [Checked], the sorting order can be selected from 

[Reverse chronological] or [Chronological].
• For [Comment], the sorting order can be selected from [Ascending] or [Descending].
• For [Status], the sorting order can be selected from [Checked->Restored->Occurred] or 

[Occurred->Restored->Checked].

[Space]

Set the space between the text to be displayed and the line.
• [X]:

Set the space in 8 dot units.
The setting range is [0], [8], [16], [24], and [32].

• [Y]:
Set the space in 1 dot unit.
The setting range is [0] to [32].

[Cursor Color] Set the cursor color for selecting a user alarm.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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3) [Shape]

(5) [Extended] tab

For mobile screens, some setting items are not available.
➟10.19.2 ■2 Usable functions

Set the operation of switching displays for the alarm display (system) by devices.

1) [Security level]
Set the security level of display and operation.

[Text color on cursor display]

Method to set the color of text on the cursor.
• [XOR]

Displays the text in the synthesized color with XOR specification.
• [Reverse]

Inverts the text.

As the setting is fixed to [XOR], no additional setting is required accordingly.

The following shows the items to be selected.
• [XOR]
• [Reverse]

Item Description

[Shape Settings]
Set a shape for the alarm display (system).
To select a shape other than those in the list box, click the [Shape] button.

[Frame Color] Set the frame color of the shape.

[Shape Color] Set the color of the shape.

Item Description

GOT Graphic Ver.2

GOT Graphic Ver.1

Item Description

[Display]
Set the security level of display. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security.

[Operation]

Set the security level of operation. 
The setting range is [0] to [15]. 
Select [0] not to set the security and select [1] to [15] to set the security. 
The setting of security level of [Operation] must be set to the one exceeding the security 
level of [Display].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

4)

5)

6) 7)
9 - 148 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

2) [User ID]
Set the user ID of the alarm display (system).
If an alarm display (system) and another alarm display are set on a screen, touch switches for the alarm display 
(system) may not function.
For secure operations of the touch switches for alarm displays (system), set user ID for the alarm displays (system).

➟9.1.5 ■2 How to use the alarm display
3) [Operation Log Target]

Select this item to target the object for the operation log.
➟5.2.11 ■1 Specifications of the operation log

4) [Switching Device]
Select items to switch the display using devices.

➟9.1.5 ■2 How to use the alarm display

5) [Display Position Time Device]

6) [Layer]
Select the layer to arrange the object on.
The following shows selectable items.

• [Front]
• [Back]

➟6.5.5 ■3 Superimposition
7) [Category]

Select the category to assign the object.
➟11.7 Managing figures and objects by category

Item Description

[Priority Display Attribute]

Switch the item to be the sort criteria according to the device values. 
Set the switching device.

➟6.1.2 How to set devices
Store values to the device to switch the order of alarm display.

• For b3 to b0, specify the sort criteria.
□000h: Normal (date and time of occurrence)
□001h: Date and time of occurrence
□002h: Date and time of restoration
□003h: Date and time of confirmation
□007h: Alarm status

• Using b14 to b4 is prohibited.
• Ascending or descending is specified for b15.

000□h: Descending
800□h: Ascending

The date and time of occurrence, cumulative time, and down time can be set only when 
the collection mode in the user alarm observation is [Cumulative]. 
If a value other than the above is stored, alarms are displayed in the order of the date and 
time of occurrence.

Item Description

[Display Position Time]

Displays the data of a specified time. (Time specification jump function) 
Set a device in which a specified time is stored.

➟6.1.2 How to set devices
The successive devices from a set device are set to store the data of year and month, day 
and hour, and minute and second.

b14 to b4 b2b3b15 b1 b0
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(6) [Trigger] tab

Set conditions for displaying the object.

1) [Control displaying/hiding]
Set the control device to display or hide all the objects including the shape frame.

2) [Trigger Type]
Select the condition of displaying and operating the object.
The following shows selectable items.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

3) [Settings]
For details of each item, refer to the following.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
9 - 150 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

(7) [External Output] tab

Configure the setting for writing the information of the alarm selected in the alarm display (system) into devices.

1) [Enable External Output]
Write the information of touched alarm into devices.

➟9.1.5 ■2 How to use the alarm display
2) [Trigger Type]

Select the timing to write the alarm information into a device.
Select [Ordinary] to write the alarm information into the device when the alarm is touched.
Select [ON] to write the alarm information into the device when the alarm display area is touched while the device is on.
Select [OFF] to write the alarm information into the device when the alarm display is touched while the device is off.

3) [Trigger Device]
When selecting [ON] or [OFF] in [Trigger Type], set the device to be a trigger.

➟6.1.2 How to set devices
4) [When cursor is hidden]

Configure the setting for external outputs of when the cursor is hidden.
• [Clear External Output Device]:

Select this item to clear the value of the external output device when no alarm is selected.
• [Output alarm information of the top row]:

Select this item to output externally the alarm information displayed at the top row when no alarm is selected.
5) [First Device]

Set the start device (word device) to which the information of the alarm is written.
When items to be written are selected, the successive devices following the start device are automatically set.

Item Description

[Identification Data] Select this item to write the alarm identification data into devices.

[Error No.] Select this item to write the error No. of an alarm into devices.

[Channel]
Select this item to write the channel No. of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[Network No.]
Select this item to write the network No. of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)

5)

6)
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[Station No.]
Select this item to write the station No. of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[CPU No.]
Select this item to write the CPU No. of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[Screen No.]
Select this item to write the screen No. of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[Definition Screen No.]

Select this item to write the definition screen No. of an alarm as added information into 
devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[Object ID]
Select this item to write the object ID of an alarm as added information into devices. 
For the added information, refer to the following.

➟9.1.5 ■5 (7) (a) Added information

[Alarm Status]

Select this item to write the alarm status into devices.

• b0:
When the alarm is in the "Occurred" status, 1 is stored, and when the alarm is in the 
"Restored" status, 0 is stored.

• b1:
When the alarm is in the "Checked" status, 1 is stored, and when the alarm is unchecked, 
0 is stored.

• b2:
When writing the alarm status into devices is enabled, 1 is stored, and when writing the 
alarm status into devices is disabled, 0 is stored.

• b15 to b3:
Using these bits is prohibited.

For the details of the write trigger, refer to the following.
➟9.1.5 ■5 (7) (b) Write trigger

[Occurred Date]

Select this item to write the date when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Occurred Time]

Select this item to write the time when an alarm has occurred into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Restored Date]

Select this item to write the date when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Restored Time]

Select this item to write the time when an alarm has been restored into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Checked Date]

Select this item to write the date when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Checked Time]

Select this item to write the time when an alarm has been checked into devices. 
For the details of the write trigger, refer to the following.

➟9.1.5 ■5 (7) (b) Write trigger
For the description of the date and time to be written, refer to the following.

➟9.1.5 ■5 (7) (c) Descriptions of the date and time to be written

[Select All] button Selects all alarm information.

[Deselect] button Cancels all the selected alarm information.

Item Description

b15 to b3 b2 b1 b0
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6) [Display Target Alarm Setting]
Set the devices to which the information on the displayed alarms is written.

(a) Added information
• By adding the information of an error that has occurred, it becomes easy to identify where the error has occurred.

The added information which is not related to the error is not added even if the information is set.

*1 The number of the symbol * represents the number of the digits of the screen No.
*2 When a displayed number contains a number of digits less than that shown in the table, the number is displayed with 0 padded.

• The following shows a display example of added information.

Item Description

[Active Alarm Status Notification]

Set the device that notifies the status of the displayed alarms. 
The following shows the notification details of each bit.

• b0 to 13:
Using these bits is prohibited.

• b14:
Stores 1 when a value greater than the number of displayed alarms is input to the device, 
which is set for [Display Start Row] on the [Alarm Setting] tab.

• b15:
Using these bits is prohibited.

[Display Target Alarm Number Output] Set the device that stores the number of displayed alarms.

Added information Description

(1) Error message Displays the error code of a system error and the error message.

(2) Channel Displays the channel No. 
The display type is DEV: Ch No.

(3) Network No. Displays the network No. with three digits number. *2

(4) Station Displays the station No. with three digits number. *2

(5) CPU No. Displays the CPU No.

(6) Device Displays the device.

(7) Screen No.*1*2

Displays the screen type and the screen No.

Base screen BASE: *****

Overlap window 1 to 5 OVL1: ***** to OVL5: *****

Superimpose window 1 to 2 SPI1: ***** to SPI2: *****

User customize dialog DLG: *****

Operation panel PNL: ***** 

Key window KEY: ****** 

Base screen (GOT Mobile) MBL-BASE: *****

Overlap window 1 to 2 (GOT Mobile) MBL-OVL1: ***** to MBL-OVL2: *****

Superimpose window 1 to 2 (GOT Mobile) MBL-SPI1: ***** to MBL-SPI2: *****

(8) Definition screen 
No.*1*2

Displays the definition screen type and the screen No.

Base screen B: *****

Window screen W: *****

Report screen R: *****

Mobile screen MB: *****

(9) Object ID Displays the object ID.

(10) Function name Displays the function name. 
Switches languages with the language switching.

(11) Drive name Displays the drive name. 
The display type is DRV: Drive name.

b13～ b0b15 b14

(1) (2) (7) (8) (9)(3) (4) (5) (6) (10) (11)

[Error Message] [Channel] [Network No.]-[Station No.]/[CPU No.] [Device]/[Screen Type]/[Definition Screen No.]/[Object ID]/[Function Name]/[Drive Name]
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

9 - 153



Channel (1), device (X1000), screen No. (overlap window 3, screen No. 251), definition screen No. (window screen, 
screen No. 251), object ID (10000), function name (shape display)

If added information is displayed, the message is longer.
When all information is not be displayed, select Flow as the display type.

• For the device to which offset is specified, the device name and address after the offset are displayed.
If the address after the offset is out of the range, ?? is displayed.
The following shows the display example of a case where the device M1000 (range: 0 to 61424) is offset.
Offset device 60000 → The device M61000 after offset is displayed.
Offset device 61000 → ?? is displayed because the device after offset is out of the range.

(b) Write trigger
• Writing by the collection mode

The available data for writing differs according to the collection mode which is set in the alarm observation.
For details, refer to the following.

➟9.1.3 ■1 Specifications of the system alarm observation

(c) Descriptions of the date and time to be written
The date and time are respectively stored in two word devices.
The following describes the case in which the time of occurrence is written into D254 (2 points) and the date of occurrence 
is written into D256 (2 points).

• Date
Store the year, month, and day with BCD code.

• Time
Stores the hour, minute, and second with BCD code.

Example) Jun. 1, 2013 12:24:56

G01-322 The specified device No. is out of the range. Check the available range. DEV:Ch1 X1000/OVL3:00251/W:00251/ID:10000/Shape display

D254

D255

Month (1 to 12) Date (1 to 31)

Two upper 
digits of year

Two lower 
digits of year

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

Minute (0 to 59) Second (0 to 59)

00 Hour (0 to 23)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D254

D255

06 01

20 13

(Month) (Date)

(Year)

b15 to b8 b7 to b0

b15 to b8 b7 to b0

D256

D257

24 56

00 12

(Minute) (Second)

(Hour)

b15 to b8 b7 to b0

b15 to b8 b7 to b0
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■6 Relevant settings

Set the relevant settings other than the specific settings for the alarm display as required.
The following shows the functions that are available by the relevant settings.

(1) GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

(2) GOT internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the objects are overlapping to each other. [Check for overlapping objects in the GOT]

Adjusting the display order of the overlapped objects on the GOT to that in GT 
Designer3.

Always enabled.
(Not available to GT21 and GS21)

[Adjust object display order in GOT to the one in GT Designer3]
(Not available to GT21 and GS21)

GOT Graphic Ver.2

GOT Graphic Ver.1

Function Setting item

Displaying the detail screen with a single touch of a basic alarm even when the 
alarm is not selected in the alarm display (user)
(Write device)

GS450.b15

Moving the cursor to a different alarm on the alarm display (user) when the alarm 
under the cursor is deleted
(Write device)

GS467.b0
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9.2 Collecting Device Data ([Logging])

9.2.1 Overview of the logging function

The logging function collects the device values of a controller at the specified time or intervals, and saves the collected data 
into the buffering area, data storage, or file server.
The logging function has two modes.
• File save mode
In this mode, logging data is saved into a data storage or file server.
The saved logging data can be output to a Unicode text file or CSV file and displayed on a personal computer.
For the details of the file save mode, refer to the following.

➟9.2.3 ■4 File save mode

• Buffer historical mode
In this mode, logging data is displayed on the GOT while the data is being collected.
To display the logging data on the GOT, use the historical trend graph or historical data list display.
For the details of the buffer historical mode, refer to the following.

➟9.2.3 ■5 Buffer historical mode
For the details of the historical trend graph and historical data list display, refer to the following.

➟8.10 Placing a Historical Data List Display
8.21 Placing a Historical Trend Graph

For the logging data that can be displayed by the historical trend graph or historical data list display in the file save mode or 
buffer historical mode, refer to the following.

➟9.2.3 ■6 Display and operation

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Collecting logging data

Data storage 
or file server

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line1
100
98
95
92

Line2
250
260
270
280

Line3 Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line1
100
98
95
92

Line2
250
260
270
280

Line3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line1
100
98
95
92

Line2
250
260
270
280

Line3

Logging data Logging data

Collecting logging data

The historical data list display or 
historical trend graph is displayed.
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9.2.2 Specifications of the logging

The following shows the specifications of the logging.

■1 Maximum number of logging settings
The maximum number of logging settings for one project depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 60 settings can be configured for one project.

• For GT21 and GS21
Up to four settings can be configured for one project.

■2 Size of the buffering area
The size of the buffering area reserved for logging data varies depending on the setting of [Log Storage Number] in the 
[Logging] dialog.
Increasing the set value of [Log Storage Number] decreases the available space in the user area.
Set [Log Storage Number] according to the capacity of the user area.

➟9.2.6 [Logging] dialog

■3 Number of logging events and saving them to a file
The setting of [Log Storage Number] determines the frequency and time required for saving data to a file.
When the set value of [Log Storage Number] is large, data saving occurs infrequently, requiring a long time.
When the set value of [Log Storage Number] is small, data saving occurs frequently, requiring a short time.

The following shows the relationship between the logging trigger, log storage number, and file saving frequency.

Collecting device values stops while logging data is being saved, so device values may not be collected correctly.
Change the setting of [Log Storage Number] according to the above settings including the logging trigger.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Logging trigger ([When to collect 
device values])

[Log Storage Number]

1 100 10000

Time interval: 10 (×100 ms) Saving every 1 sec Saving every 100 sec Saving every 10000 sec

Time interval: 1000 (×100 ms) Saving every 100 sec Saving every 10000 sec Saving every 1000000 sec
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■4 Logging trigger and logging process
If the conditions of multiple logging triggers are satisfied simultaneously, device data logs are taken in parallel.
Example) When the logging trigger conditions of logging ID No. 1 to 3 are satisfied simultaneously
• Logging ID No. 1 and 2: A device of channel No. 1 is set as the logging target.
• Logging ID No. 3: A device of channel No. 2 is set as the logging target.

The device data logs of the same channel are taken one by one, and therefore a waiting time occurs, causing a longer 
logging time.

9.2.3 How to use the logging

The logging function can be executed according to the device status or in intervals.
➟9.2.6 [Logging] dialog

■1 Logging mode

The file save mode and buffer historical mode are provided as the logging mode.

*1 When the number of events in a logging file exceeds the limit, a new logging file is automatically created.
To specify the limit, set [Number of logs to be stored in 1 logging file] in the [Logging] dialog.

*2 To restore logging data in the event of a power failure, save the data in the buffering area into a data storage or file server.

➟9.2.3 ■5 (1) Saving data
*3 To specify the number of events to be temporarily stored in the buffering area, set [Log Storage Number] in the [Logging] dialog.

Logging trigger for logging ID No. 1
([Trigger Type]: [Rise])

OFF

ON

Logging trigger for logging ID No. 2
([Trigger Type]: [Rise])

Logging trigger for logging ID No. 3
([Trigger Type]: [Rise])

Logging ID No. 1 Being processed

Logging ID No. 2 Being processed

Logging ID No. 3 Being processed

OFF

ON

OFF

ON

Waiting for 
communication

While logging ID No. 1 is in the process of logging the value of 
a device in CH1, logging ID No. 2 waits for communicating with CH1.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item
Logging mode

File save mode Buffer historical mode

Application To save large amount of logging data
To execute display by the historical trend graph 
or historical data list display at high speed and to 
execute high-speed logging

Location where the collected data is saved
Logging data is temporarily saved in the 
buffering area, and then saved into a data 
storage or file server. *1

Logging data is temporarily saved into the 
buffering area. *2

Operation when the buffering area is full *3 The logging data in the buffering area is saved 
into a data storage or file server.

Select either of the following.
• Do not add the new data.
• Delete the old data.

Saved-file format Binary file (*.G2L) *4 Binary file (*.G2L) *4

Uses of the logging data in a data storage or file 
server To display the collected data Power-failure backup for the buffering area

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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*4 The data can be output to a Unicode text file or CSV file to be displayed on a personal computer.

➟9.2.3 ■7 Creating a Unicode text file or CSV file

■2 Device

The logging status can be output to devices.
The following shows the devices to be used by the logging function.

(1) Logging Notification device
Notifies that device data is being collected in the buffering area.
Set this device for each logging setting (logging ID).
The operation varies depending on the trigger type of the logging trigger.
When the trigger type is [Rise] or [Fall], establish a handshake between the Logging Notification device and the logging 
trigger to ensure data collection by logging.

(a) When the trigger type of the logging trigger is [Rise] or [Fall]
When the logging trigger turns on and device data collection starts, the Logging Notification device turns on.
When the logging trigger turns off and the processing is completed, the Logging Notification device turns off.
To ensure data collection by establishing a handshake, the following operations are required.

• Check that the Logging Notification device turns on, and then turn off the logging trigger.
• While the Logging Notification device is off, turn on the next logging trigger.

Example) When the trigger type is [Rise]

(b) When the trigger type of the logging trigger is [Rise/Fall], [Sampling], [ON Sampling], or [OFF 
Sampling]
When the logging trigger turns on and device data collection starts, the Logging Notification device turns on.
When the processing is completed, the Logging Notification device turns off.
If the interval for the trigger is set to a high speed (for example, 100 msec), the Logging Notification device may not provide 
notification at each logging depending on the communication performance.

(2) Full Notification Signal device
Notifies that the buffering area is full.
Use this device in the buffer historical mode.
This device is settable in the [Logging] dialog (traditional display) only.

(3) Buffer Historical Data Cleared device
Turning on the buffer historical data clear trigger starts clearing the logging data in the buffering area. The Buffer Historical 
Data Cleared device notifies the completion of clearing the data.
To specify the buffer historical data clear trigger, set [Delete all the histories] in the [Logging] dialog.
To specify the Buffer Historical Data Cleared device, set [Notify when all the histories are deleted] in the [Logging] dialog.
Use this device in the buffer historical mode.

(4) Logging Count device
Notifies the number of collection times of device values after the GOT is started.
You can check that the logging operates normally with this device.
The count cycles through 0 to 65535. (for unsigned BIN16)
The count is cleared when the GOT is powered off, reset, or restarted.
This device is settable in the [Logging] dialog (traditional display) only.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

If the logging trigger is not turned 
off, the Logging Notification 
device does not turn off at 
completion of data collection.Logging Notification

Device

Even though the logging trigger is turned on while the Logging 
Notification device is on as (3) and (4) in the following diagram, relevant 
data collection does not occur.

Logging trigger

Collecting device
data

OFF

ON

OFF

ON

（1）

（1）

（2） （4）

（1）

ON ON ON

ON

（2）

（3）
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(5) Writing Notification device
This device is settable only when file save mode is selected in the [Logging] dialog (traditional display).
The device notifies that the logging data stored in the buffering area is being written to a temporary file.
Set this device for each logging setting (logging ID).
The device is used with the storage trigger and causes different operations depending on the trigger type of the storage 
trigger.
When the trigger type of the storage trigger is [Rise] or [Fall], establish a handshake between the Writing Notification 
device and the storage trigger to ensure execution of writing.

(a) When the trigger type of the storage trigger is [Rise] or [Fall]
When the storage trigger turns on and writing starts, the Writing Notification device turns on.
When the storage trigger is off and the processing is completed, the Writing Notification device turns off.
To ensure execution of writing by establishing a handshake, the following operations are required.

• Check that the Writing Notification device turns on, and then turn off the storage trigger.
• While the Writing Notification device is off, turn on the storage trigger.

When the Writing Notification device is on, writing does not occur even if the storage trigger turns on.
The relationship between the storage trigger, writing, and the Writing Notification device is the same as the relationship 
between the logging trigger, data collection, and the Logging Notification device.
For details, refer to the following.

➟(1) Logging Notification device

(b) When the trigger type of the storage trigger is [Rise/Fall], [Sampling], [ON Sampling], or [OFF 
Sampling]
When the storage trigger turns on and writing starts, the Writing Notification device turns on.
When the processing is completed, the Writing Notification device turns off.

(6) Writing Error Notification device
This device is settable only when file save mode is selected in the [Logging] dialog (traditional display).
The device notifies that an error has occurred while the logging data stored in the buffering area is being written to a 
temporary file.
Set this device for each logging setting (logging ID).
If this device is turned on, check the following.
• The SD card cover of the GOT is closed.
• The SD card access switch of the GOT is turned on.
• The data storage or file server works normally.
The user needs to turn off this device.

(7) Notify File Creation device (File Terminal Notification device)
Use this device with the file creation trigger (file terminal trigger) in file save mode.
The device notifies that the data in the buffering area is being saved to a logging file. Set this device for each logging 
setting (logging ID).

When the file creation trigger turns on and a logging file save starts, the Notify File Creation device turns on.
When the file creation trigger is off and the processing is completed, the Notify File Creation device turns off.

In the following cases, a logging file save does not occur even when the file creation trigger turns on.
• When the device data is being read: The Notify File Creation device does not turn on until one logging's worth of device 
data has been collected.

• When the Notify File Creation device is on

For the file save operation when the file creation trigger is used, refer to the following.
➟9.2.3 ■4 (1) Saving data

Note that when the Notify File Creation device is on, data collection does not occur even when the trigger device turns on.
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■3 SRAM power-failure backup function

This function saves the logging data collected in the buffering area to the SRAM user area.
The logging data saved in the SRAM user area is retained even at power failure.
Saving data to the SRAM user area for backup at power failure can be used for the following functions.
• User alarm observation
• System alarm observation
• Logging function

(1) Saving data to the SRAM user area
When logging data is collected to the buffering area, the logging data is also saved to the SRAM user area.
This saving timing cannot be changed.
When the SRAM user area has logging data, the logging data is automatically read when the GOT is powered on.
Up to 20 logging settings can be configured with the SRAM power-failure backup function enabled.

(2) Specifications of the SRAM user area
For the specifications of the SRAM user area, refer to the following.

➟12.12 Specifications of the SRAM user area

(3) Deleting and backing up the data in the SRAM user area
The data saved in the SRAM user area is deleted under the following conditions.

• Project data and system applications are written to the GOT when [Initialize SRAM user area when writing project 
data/OS] is selected in the [Communicate with GOT] dialog.

• The SRAM user area is initialized by using [SRAM management] in the utility.
• The clear trigger device set in [Buffering] of the user alarm observation setting or the system alarm observation 

setting turns on.
• The SRAM user area is set to be initialized when GT SoftGOT2000 starts the first monitoring.

To retain the data saved in the SRAM user area, execute the backup/restoration function in the utility.
For the details of the backup/restoration function, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(4) Precautions for the power-failure backup of the SRAM user area
Data may not be saved into the SRAM user area due to some reasons, including the setting change of an applicable 
function and physical memory corruption.

(a) Normal conditions
The data collected by each applicable function is saved to the SRAM user area.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Logging data

Logging data

Operation memory (RAM)

SRAM

Buffering area

SRAM user area

When the trigger condition of the controller 
is satisfied, logging data is collected to 
the buffering area.

GOT

The logging data collected in the buffering area is 
saved to the SRAM user area for power-failure backup.

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

Details of the SRAM 
user area

500KB

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
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(b) Setting change
If the size of data to be collected by the user alarm observation, system alarm observation, or logging function is changed, 
the data of the function saved in the SRAM user area will be deleted.

• When the size is reduced:
The data is saved to the initialized area. The remaining area is reserved as a free area.

• When the size is increased:
The area used is initialized and the data is saved to another area.
If the area required for saving the data is insufficient, an error occurs.
If an error occurs, initialize the SRAM user area, reduce the data size to 500 KB or less, and save the data again.
Example) When the size for ID 1 is increased from 100 KB to 200 KB

(c) Setting deletion
When the setting of each function is deleted, the SRAM user area used for saving the data is reserved as an unused area.
Initialize the unused area to use it.
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)
Example) When the setting of ID 1 is deleted

(d) Others
If the data saved in the SRAM user area is not restored at the GOT startup, a system alarm occurs.
In such a case, check the battery status.

• When the battery status is normal:
A part of the SRAM user area may be damaged.
Initialize the SRAM user area.

➟GOT2000 Series User's Manual (Utility)
• When the voltage is low:

Replace the battery.
If the data is still not restored after the battery is replaced, initialize the SRAM user area.
For information on how to replace the battery, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)

ID2: 100KB
ID3: 200KB

Free area

Free areaID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area is initialized.
In this case, ID 1 cannot be saved to 
another area, and an error occurs.
The initialized area becomes a free area.

Reserved area
ID2: 100KB
ID3: 200KB

Free area

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area for ID 1 becomes a 
reserved area.
By setting the setting of ID 1, the saved 
data can be retained for other use.
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■4 File save mode

In this mode, logging data is saved into a data storage or file server.
When a file is filled with data, a new file is created to save the subsequent data, enabling saving a large amount of logging 
data.
Use the file save mode in the following cases.
• To save a large amount of logging data
• To automatically create a file to save logging data if the number of the events saved in the current file has reached the limit
Example) Saving one day's logging data into files

Step 1 When the condition of the logging trigger is satisfied, the device values of the controller are collected and 
temporarily saved in the buffering area.

Step 2 The logging data in the buffering area is saved into a data storage or file server.
Step 3 The collected logging data can be used for the following applications.

• Log analysis after the data is output to a Unicode text file or CSV file
➟9.2.3 ■7 Creating a Unicode text file or CSV file
• Display by the historical trend graph or historical data list display
➟9.2.3 ■6 Display and operation

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The logging data is saved into a data storage or file server.

The historical data list display or 
historical trend graph is displayed.

Logging 
data

Operation memory (RAM)
Buffering area

When the condition of the logging trigger is 
satisfied, the device values of the controller 
are collected to the buffering area.

1
2
3

2013/6/1 9:00:00    150       300
2013/6/1 9:01:10    174       312
2013/6/1 9:02:00    196       305

Line1 Line2 Line1 Line2TimeNo. of events

2009/4/6 22:09:00  215       32065500

LOG00001_0001.G2L LOG00001_0002.G2L

1
2
3

2013/6/2 9:00:00    140       302
2013/6/2 9:01:10    145       317
2013/6/2 9:02:00    150       307

TimeNo. of events

Up to 65500 events can be logged to a file.
If the number of events in a logging file exceeds the value specified for [Number of logs to be 
stored in 1 logging file], a new logging file is automatically created as needed to accommodate 
subsequent event data.
Up to 9999 files can be created.

1.

2.

3.
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(1) Saving data
In the file save mode, the logging data in the buffering area is saved into a data storage or file server at the following 
timing.
• When the reserved portion of the buffering area becomes full
• When the file creation trigger is turned on regardless of the number of events in the buffering area

(a) Saving logging data when the reserved portion of the buffering area becomes full
When the number of events in the buffering area has reached the set value of [Log Storage Number] in the [Logging] dialog, 
the events are automatically saved into a data storage or file server.
Example) When [Number of logs to be stored in 1 logging file] is set to 30

Step 1 When the buffering area becomes full, the logging data in the buffering area is automatically saved into a 
data storage or file server.

Step 2 The data is saved to a temporary file (file number: 0000).
Step 3 When the number of events in the temporary file reaches the value specified for [Number of logs to be stored 

in 1 logging file], the event data is saved to a logging file (file number: 0001 to 9999).
After the number of logging files reaches the value specified for [Maximum number of files to store logs], file 
number 0001 is assigned to a new logging file.
In this case, the existing logging file numbered 0001 is overwritten.
When [Maximum number of files to store logs] is set to 12

To avoid overwriting an existing logging file in the data storage or file server, back up the file to another location.
Step 4 After the logging file is saved, the logging data in the temporary file is automatically deleted and the logging 

resumes.

Buffering area

No. of events Time

1
2

2013/6/1 9:20:00
2013/6/1 9:21:00

Line1

205
211

Line2

216
217

10
11

2013/6/1 9:29:00
2013/6/1 9:30:00

230
231

217
220

20 2013/6/1 9:39:00 250 210

Data storage 
or file server

Data storage 
or file server

Temporary file 
(L0G00001_0000.G2L)

21
22

2013/6/1 9:20:00
2013/6/1 9:21:00

205
211

216
217

30 2013/6/1 9:29:00 230 217

No. of events Time

1
2
3

2013/6/1 9:00:00
2013/6/1 9:01:00
2013/6/1 9:02:00

Line1

150
174
196

Line2

256
255
254

20 2013/6/1 9:19:00 215 250

31 2013/6/1 9:30:00 231 220

40 2013/6/1 9:39:00 250 210

Created logging file (L0G00001_0001.G2L)

20
21
22

2013/6/1 9:19:00
2013/6/1 9:20:00
2013/6/1 9:21:00

215
205
211

250
216
217

30 2013/6/1 9:29:00 230 217

No. of events Time

1
2
3

2013/6/1 9:00:00
2013/6/1 9:01:00
2013/6/1 9:02:00

Line1

150
174
196

Line2

256
255
254

Temporary file (L0G00001_0000.G2L)

No. of events Time Line1 Line2

1 2013/6/1 9:30:00 231 220

10 2013/6/1 9:39:00 250 210

The buffering area is full.1. The logging data is added to the 
temporary file.

2. When the number of events in the temporary 
file reaches the value specified for [Number 
of logs to be stored in 1 logging file], 
the event data is saved to a logging file.

3.

The logging data saved in a file is 
deleted from the temporary folder.

4.
Add

File 
creation

Remains in the temporary file.

The contents are overwritten.

LOG00001_0001.G2L
LOG00001_0002.G2L

LOG00001_0012.G2L

LOG00001_0001.G2L
LOG00001_0002.G2L

LOG00001_0012.G2L

File creation
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(b) Saving logging data by using the file creation trigger
To save logging data to a file at an intended timing regardless of the number of events in the buffering area, use the file 
creation trigger.
To specify the file creation trigger, set [Create a logging file at any desired time] in the [Logging] dialog.
Example) When [Number of logs to be stored in 1 logging file] is set to 30

Step 1 Turn on the file creation trigger to add the logging data stored in the buffering area to a temporary file.
Step 2 The logging data in the temporary file (file number: 0000) is saved to a logging file (file number: 0001 to 

9999).
(The data is saved regardless of the number of logs.)
After the number of logging files reaches the value specified for [Maximum number of files to store logs], file 
number 0001 is assigned to a new logging file.
In this case, the existing logging file numbered 0001 is overwritten.
When [Maximum number of files to store logs] is set to 12

To avoid overwriting an existing logging file in the data storage or file server, back up the file to another location.
Step 3 After the logging file is saved, the logging data in the temporary file is automatically deleted and the logging 

resumes.

Buffering area

No. of events Time

1
2

2013/6/1 9:20:00
2013/6/1 9:21:00

Line1

205
211

Line2

216
217

7 2013/6/1 9:26:00 230 217

Data storage 
or file server

Data storage 
or file server

Temporary file (L0G00001_0000.G2L)

20
21
22

2013/6/1 9:19:00
2013/6/1 9:20:00
2013/6/1 9:21:00

215
205
211

250
216
217

27 2013/6/1 9:26:00 230 217

No. of events Time

1
2
3

2013/6/1 9:00:00
2013/6/1 9:01:00
2013/6/1 9:02:00

Line1

150
174
196

Line2

256
255
254

Created logging file (L0G00001_0001.G2L)

20
21
22

2013/6/1 9:19:00
2013/6/1 9:20:00
2013/6/1 9:21:00

215
205
211

250
216
217

27 2013/6/1 9:26:00 230 217

No. of events Time

1
2
3

2013/6/1 9:00:00
2013/6/1 9:01:00
2013/6/1 9:02:00

Line1

150
174
196

Line2

256
255
254

Temporary file 
(L0G00001_0000.G2L)

No. of events Time Line1 Line2

Turning on the file creation trigger adds 
the logging data stored in the buffering area 
to a temporary file.

1. A logging file is created.2.

The logging data saved in a logging file 
is deleted from the temporary file.

3.

Add

File 
creation

The contents are overwritten.

LOG00001_0001.G2L
LOG00001_0002.G2L

LOG00001_0012.G2L

LOG00001_0001.G2L
LOG00001_0002.G2L

LOG00001_0012.G2L

File creation
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.2 Collecting Device Data ([Logging])

9 - 165



■5 Buffer historical mode

In the buffer historical mode, the logging data in the buffering area is displayed quickly on a historical trend graph or 
historical data list display.
Use the buffer historical mode in the following cases.
• To execute the historical trend graph or historical data list display at high speed and to execute logging at high speed
• When saving a large amount of logging data is not required

Step 1 When the condition of the logging trigger is satisfied, the device values of the controller are collected and 
temporarily saved in the buffering area.

Step 2 The logging data that is temporarily saved in the buffering area is displayed by the historical trend graph or 
historical data list display.

(1) Saving data
In the buffer historical mode, the logging data in the buffering area is saved into a data storage or file server when [Buffer 
Save] is enabled.
The logging data can be automatically restored from the data storage or file server upon turn-on of the GOT.
The following shows the uses of this setting.
• To retain logging data in the event of an accident, such as a power failure
• To save logging data into a data storage or file server when the buffering area becomes full

(a) Restoring logging data from a data storage or file server
Connect a data storage or file server, and then turn on the GOT.
Do not perform the above operations in reverse order, or logging data cannot be restored from the data storage or file server 
upon turn-on of the GOT.
The wrong procedure will also cause the logging data in the data storage or file server to be overwritten with new data after 
the GOT is turned on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The historical data list display or 
historical trend graph is displayed.

Logging 
data

Operation memory (RAM)
Buffering area

When the condition of the logging trigger is 
satisfied, the device values of the controller 
are collected to the buffering area.

1. 2.

Logging 
data

Operation memory (RAM)
Buffering area

Logging data before 
the GOT is powered off

Logging 
data

Logging data after the 
GOT is powered on

Logging 
data

Operation memory (RAM)
Buffering area

Power OFF Power ON

Saving the logging data into a data storage or file server
・Setting the timing for saving the data
　(rise, fall, none, sampling, ON sampling, OFF sampling)
・Saving the data with a touch switch

Data storage 
or file server
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(b) Restoring logging data when the power-failure backup is used
GT21 and GS21 do not support the SRAM power-failure backup function.
If logging data is saved into both the SRAM user area and a data storage or file server, the logging data is restored from 
the SRAM user area upon turn-on of the GOT.
If the SRAM user area is unusable due to the undervoltage battery or other causes, the logging data is restored from the 
data storage or file server.

(c) When the reserved portion of the buffering area becomes full
To notify that the number of events in the buffering area reaches the value specified for [Log Storage Number], set [Full 
Notification Signal Device].
With additional setting, the following usages are available.

• Notifying the full status before the buffering area is actually full by setting [Buffer Full Alert Capacity]
• Providing options for the full status using [Action When Buffer is Full]

• Deleting the logging data in the buffering area without saving using [Buffer Historical Data Clear]

[Full Notification Signal Device] and [Buffer Full Alert Capacity] are settable in the [Logging] dialog (traditional display) only.
➟9.2.7 [Logging] dialog (traditional display)

Save Delete

100

50

0
0 -1 -2 -3

Full 
notification: 

Full notification OFF → ON

Upon turn-on of the full notification device, the logging data 
in the buffering area is saved into a data storage or file server.

Save Delete

100

50

0
0 -1 -2 -3

Full 
notification: 

Full notification ON → OFF

The logging data in the buffering area is deleted.
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■6 Display and operation

The following shows how to display and operate logging data collected through the GOT or personal computer.

(1) Display by the historical trend graph or historical data list display
Collected logging data can be displayed by the historical trend graph or historical data list display.
Specify the data to be displayed by logging ID.

➟8.10 Placing a Historical Data List Display
8.21 Placing a Historical Trend Graph

(a) Display target in the file save mode
The logging data in the buffering area, data storage, or file server is displayable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Historical trend graph Historical data list display

Operation memory (RAM)

Logging 
data

Logging 
data

Logging 
data

Buffering area 
(for the logging function)

Buffering area 
(for the historical trend graph 
or historical data list display)

Data storage 
or file server
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(b) Display target in the buffer historical mode
The logging data in the buffering area is displayable.
The logging data in a data storage or file server is not displayable.
To display old logging data, use the file save mode.

(2) Operations with the utility
The following operations can be performed with the utility.
You can manage logging files on the GOT without a personal computer.

➟GOT2000 Series User's Manual (Utility)

Operation memory (RAM)

Logging 
data

Logging 
data

Buffering area 
(for the logging function)

Buffering area 
(for the historical trend graph 
or historical data list display)

The logging data in the data storage 
or file server is not displayed.

Logging 
data

Data storage 
or file server

Item Description

Creating a folder

Not available to GT21 and GS21.
Creates a folder where logging files are stored. Folders can be created for each line and 
production item to manage logging files.

Deleting a folder
Not available to GT21 and GS21.
Deletes a folder where logging files are stored.

Copying a file
Copies a logging file.
Perform this operation to back up a logging file.

Deleting a file Deletes a logging file.

Renaming a file
Not available to GT21 and GS21.
Renames a logging file.

Moving a file
Not available to GT21 and GS21.
Moves a logging file to another folder.
Perform this operation to back up a logging file.

Converting a binary file (*.G2L) into a Unicode text file 
or CSV file

Not available to GT21 and GS21.
Converts the binary file (*.G2L) into a Unicode text file or CSV file.

Logging file storage 
folder for line1

Logging file storage 
folder for line2

Logging file storage 
folder for line3

Create a folder for each line or production item.
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.2 Collecting Device Data ([Logging])

9 - 169



(3) Saving logging data in Unicode text file format or CSV file format and displaying it with a personal 
computer
Collected logging data is saved in a binary file (*.G2L).
With this binary file, a Unicode text file or CSV file can be created to display the data on a personal computer.

➟9.2.3 ■7 Creating a Unicode text file or CSV file

(a) When displaying logging data in the multiple-language input environment
When displaying logging data in the multiple-language input environment, use Unicode text files.
The characters of multiple languages can be displayed normally by using Unicode text files.

(b) Display example and detail of logging data
The following shows the display format of logging data in the binary file (*.G2L) that has been output to a Unicode text file 
or CSV file.

1) Logging ID
Displays the logging ID.

2) Logging name
Displays the logging name.

3) Serial number
Displays a number 0001 to 9999 attached to the end of the file name.

4) Number of set devices
Displays the number of set devices.

5) Number of logs
Displays the number of logs.

6) Order of dates
Displays the order of dates.

7) Time zone
Displays the difference between the Greenwich Mean Time and "Occurred"/"Restored"/"Checked".

8) Time information
Displays the information on the time data.

• L: Local time
9) Device comment

Displays device comments.
10) Device type

Displays device types.
• [BIT]: Bit
• [BIN8]: Signed 8-bit binary

Unicode text file or CSV file
Logging 

data

1)
2)
3)
4)
5)
6)
7)

9)
10)
11)
12)

13) 14)

8)
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• [BIN8_Unsigned]: Unsigned 8-bit binary
• [BIN16]: Signed 16-bit binary
• [BIN16_Unsigned]: Unsigned 16-bit binary
• [BIN32]: Signed 32-bit binary
• [BIN32_Unsigned]: Unsigned 32-bit binary
• [BIN64]: Signed 64-bit binary
• [BIN64_Unsigned]: Unsigned 64-bit binary
• [BCD16]: 16-bit binary-coded decimal
• [BCD32]: 32-bit binary-coded decimal
• [BCD64]: 64-bit binary-coded decimal
• [REAL]: Real numbers (32 bits)
• [REAL64]: Real numbers (64 bits)
• [STRING]: Character string

11) Display format
Displays the display formats.

• [BIT]: Bit
• [DEC]: Signed decimal
• [UNSIGNED_DEC]: Unsigned decimal
• [REAL_FLOAT]: Real number (exponential expression)
• [REAL_FIX]: Real number (fixed-point number)
• [ASC]: ASCII code
• [UNI]: Unicode
• [SJIS]: Shift JIS code
• [KS]: KS (Korean)
• [GB]: GB (Simplified Chinese)
• [BIG5]: BIG5 (Traditional Chinese)
• [BIN]: Binary number
• [OCT]: Octal number
• [HEX]: Hexadecimal number

12) Device size
Displays the device size. (Unit: byte)

• 1: Bit device or word device (16 bits)
• 2: Word device (32 bits)
• 4: Word device (64 bits)
• 1 to 250: Character string

13) Time data
Displays the time when the device value is collected.

14) Logging data
Displays the collected device values.
If a communication timeout occurs or the values are outside the device range, nothing is displayed.
If the device values cannot be collected when the logging trigger condition is satisfied, the display depends on whether 
the missing logging data detection function is enabled or disabled.

• Disabled: Previously collected values
• Enabled: [-]s (hyphens)

For the missing information, refer to the following.
➟9.2.3 ■9 Missing logging data detection function
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■7 Creating a Unicode text file or CSV file

(1) Creating a Unicode text file or CSV file when saving logging data into a data storage or file server
When logging data is saved into a data storage or file server, a Unicode text file or CSV file can be automatically created 
to save the data.

Step 1 Select [Output additional file] and configure the setting in the [Logging] dialog.

Step 2 When a binary file is saved, a Unicode text file or CSV file is also automatically created.
A Unicode text file or CSV file is not created at the timing of when a temporary file is created.
➟9.2.3 ■4 File save mode

While the file is being created, the logging is stopped.
To shorten the interruption time, clear [Output additional file], and convert the binary file (*.G2L) to a Unicode text file or 
CSV file with GT Designer3 or the utility.
GT21 and GS21 do not support the conversion with the utility.

(2) Creating a Unicode text file or CSV file with GT Designer3
On GT Designer3, a binary file (*.G2L) in the data storage or file server can be converted into a Unicode text file or CSV 
file.
Since the file is converted with GT Designer3, converting is processed without any load on the GOT.
For the details of the [Logging File Conversion] dialog, refer to the following.

➟9.2.8 [Logging File Conversion] dialog

(3) Creating a Unicode text file or a CSV file with the utility
Not available to GT21 and GS21.
In the GOT utility, a binary file (*.G2L) in the data storage or file server can be converted into a Unicode text file or CSV 
file.
GT Designer3 is not required for the conversion.

Step 1 Select a G2L file in [Logging Information] of the utility and touch the [G2L → CSV] button or the [G2L → TXT] 
button to convert the file.
For the operations of the utility, refer to the following.
➟GOT2000 Series User's Manual (Utility)

Step 2 Store the created Unicode text file or CSV file into a personal computer by either of the following methods.
Set the following items and convert a binary file into a Unicode text file or a CSV file.

• Transferring with GT Designer3
Select [Communication] → [Read from GOT...] from the menu to transfer a file to the personal computer.

• Saving the file into a data storage or file server
Save the file into a data storage or file server, and then read the file into the personal computer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■8 Management of logging setting

Multiple logging can be managed with one recipe setting by setting the following items.
• Logging ID
• Number of blocks

(1) Logging ID
The logging ID is for distinguishing the logging settings.
The logging ID is used to select data to be displayed by the historical trend graph or historical data list display.

➟8.10 Placing a Historical Data List Display
8.21 Placing a Historical Trend Graph

(a) Setting method
Set the logging ID in the [Logging] dialog.

➟9.2.6 [Logging] dialog

(b) Setting range
The setting range of the logging ID is 1 to 32767.
However, up to 60 logging settings are settable.
(For GT21 and GS21, up to four logging settings are settable.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

32767

Logging ID 100Logging ID 10Logging ID 1

Logging ID

Block
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(2) Block
Blocks are units for setting device numbers randomly and different device types.
By setting device numbers and device types in block units, the following settings can be made.
• Mixing multiple device types (including bits and words)
• Mixing the consecutive setting and the random setting of device numbers

(a) Setting method
Set the number of blocks in the [Device] tab of the [Logging] dialog.

➟9.2.7 ■2 [Device] tab
The following shows a logging setting example in which bit devices, word devices (signed 16-bit binary and signed 32-bit 
binary data), and character strings are mixed.

(b) Setting range
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 250 blocks can be set for one logging setting.

• For GT21 and GS21
Up to 20 blocks can be set for one logging setting.

(3) Device
(a) Number of devices that can be set

The number of devices that can be set is 250 per logging setting.
One device is calculated as one device regardless of the device type (word/bit).
However, a device that has 32-bit data is counted as two devices.
When multiple blocks exist, the number of devices that can be set is the total number of devices in all blocks. Example)
Block 1: 30 devices, Block 2: 70 devices, Block 3: 120 devices
The number of devices that can be set is 30 + 70 + 120 = 220 devices.

(b) When setting device numbers at random
A single device number can be set for a single block.
To set device numbers randomly, divide the block.

(c) When the device type is bit
Only one device can be set for one block (fixed).

Block 1

Specify the 
number of blocks.

Set [Device], [Device Type], [Points], 
and [File Output Attribute] for each block.

Block 2

Block 3

Block 4
Block 5
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■9 Missing logging data detection function

After data logging, if the communication process between the controller and the GOT is not complete before the next data 
logging, the device values may not be collected even when the logging trigger condition is satisfied.
In this case, the previously collected device values are stored in the buffering area and output to a logging file.
When the missing logging data detection function is enabled, the uncollected device values are handled as the missing 
information and output as [-]s (hyphens) to a logging file.
The missing information is not displayed on the historical trend graph.

(Example) When [500] is the previously collected value in device D200, and the device value cannot be collected when 
the logging trigger condition is satisfied

The following shows an example of when the missing logging data detection function is enabled.

For the countermeasures against failure to collect device values when the logging trigger condition is satisfied, refer to 
the following.

➟9.2.4 ■2 (3) Causes and countermeasures when device values cannot be collected as set

You can set whether to enable or disable the missing logging data detection function for each logging setting.
This setting is available in the [Logging] dialog (traditional display) only.
For the setting procedure, refer to the following.

➟9.2.7 ■1 [Basic] tab

If a communication timeout occurs or the values are outside the device range, the device values are not recorded 
regardless of whether the missing logging data detection function is enabled or disabled.

Missing logging data detection 
function

Device value stored in the buffering area Value output to a logging file

Previously 
collected

Uncollected when the logging trigger condition is 
satisfied

Disabled 500 500 (Previously collected value) 500 (Previously collected value)

Enabled 500 500 (Previously collected value) - (Hyphen)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

D100 : 700
D200 : 500

D100 : 800
D200 : 900

Device

D100

D200

700

500

D100

D200

800

500

Value stored in the 
buffering area Device Value stored in the 

buffering area

Handled as the missing 
information

Previously collected value 
in [D200] even though the 
logging trigger condition is 
satisfied
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9.2.4 Precautions

This section explains the precautions for using the logging function.

■1 Precautions for drawing
(1) Setting of [Log Storage Number] in the file save mode

To collect device values in short intervals, set a larger number in [Log Storage Number].

(2) Mixing the file save mode and buffer historical mode
Do not set the same name for multiple folders or files. If the same name is used for multiple folders or files, logging is not 
executed normally.

To check the duplication, select [Tools] → [Data Check] from the menu.

(3) Setting value of logging setting
The set size of an object cannot exceed the user area of the GOT.
Depending on the combination of the settings, not all the setting values (such as the number of devices) can be set to 
their maximum values.
Set the setting values within the capacity of the available user area for the GOT.

(4) Relation between device comments and their setting sizes
Device comments affect the setting size of the logging and its file size. If device comments are set for each device, their 
setting sizes and the file size are large.

(5) When setting a string-type label or tag for the logging device
Set [Device Type] to [String].

(6) Character code when a string-type label or tag is set for the device whose [Device Type] is set to 
[String]
If you set a string-type label or tag for the device whose [Device Type] is set to [String], set the character code according 
to the type of the label or tag.

• System label Ver.1: ASCII code or Shift JIS code
• System label Ver.2 and global label: ASCII code, Unicode, or Shift JIS code
• OMRON NJ/NX tag: Unicode
• AB native tag: ASCII code
• OPC UA tag: Unicode

(7) When multiple GOTs use the network drive
If the logging files of the GOTs are saved into a single folder, logging cannot be executed normally due to data loss or 
file corruption.
When the GOTs have the same file save destination, select [Separate destinations for each GOT] in the [Logging] dialog.

➟5.3.15 ■4 Creating a folder for each GOT
9.2.6 [Logging] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

In the file save mode

In the buffer historical mode
Do not set the same name 
for multiple folders or files.

In the file save mode, LOG00001.G2L is saved as a management 
file together with LOG00001_****.G2L (* indicates a number).
The file name is duplicated with the file name in the buffer historical 
mode LOG00001.G2L, and thus logging is not executed normally.
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■2 Precautions for use
(1) Saving a file

A data storage or file server is required to save files.
The data storage or file server must have enough space to save logging files.

➟12.11.2 Size of the resource data file
If no data storage or file server is connected, files fail to be saved and the Writing Error Notification device is turned on.
Device values are not collected until the files are successfully saved.
To resume saving files and collecting device values, connect a data storage or a file server.

(2) To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

(3) Causes and countermeasures when device values cannot be collected as set
In the following cases, device values may not be collected in set intervals or when the trigger device is turned on.
• The communication between the GOT and controllers takes a long time because a large number of devices to be 
collected is set.

• After data logging, the communication process is not complete before the next data logging due to short intervals set 
for the logging trigger. (The trigger condition is satisfied while device values are being collected.)

Example) When the interval for the logging trigger is short

Take one of the following countermeasures.
• Split the logging setting to reduce the number of devices per setting.
• If the trigger type is [Sampling], set a longer interval.
Example) Splitting a logging setting into one for data logging in short intervals and one for long intervals

Collecting

ON

Logging trigger

Collecting device values 
to the buffering area Collecting

OFF

D100 → D200
D102 → D202
D104 → D204
D106 → D206
D108 → D208

D101 → D201
D103 → D203
D105 → D205
D107 → D207
D109 → D209

Interval: 10 (×100 ms)
Logging setting (logging ID 1)

Separate the settings.

Source → Destination

D101 → D201
D103 → D203
D105 → D205
D107 → D207
D109 → D209

Interval: 100 (×100 ms)
Logging setting (logging ID 2)

Source → Destination

D100 → D200
D102 → D202
D104 → D204
D106 → D206
D108 → D208

Interval: 10 (×100 ms)
Logging setting (logging ID 1)

Source → Destination

Setting for short intervals Setting for long intervals
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• While the Logging Notification device is off, satisfy the trigger condition.
➟9.2.6 [Logging] dialog

• If the baud rate can be changed, increase the baud rate with communication detail settings.
If no device value can be collected, it is collected when the trigger device is turned on next time. The device values when 
the trigger device is turned on next time are to be collected.

(4) Consistency between the device values in the controller and the collected device values
If the number of target devices of logging is large, the device values in the controller may be inconsistent with the collected 
device values.

In this case, set an interlock to prevent the device values in the controller from being changed until logging by the GOT 
is completed.
The logging status can be check by [Logging Notification Device].

➟9.2.6 [Logging] dialog

(5) Collecting device values when a file server is used
When a file server is specified to save logging data, saving logging data to a file takes a longer time than when a data 
storage is specified.
Namely, when a file server is specified, device values are uncollected for a longer time than when a data storage is 
specified because device values cannot be collected while logging data is being saved.
For details on when device values cannot be collected, refer to the following.

➟(7) Timing at which processing is stopped or on hold
Specify a data storage to save logging data, and transfer the saved data to a file server to shorten the time during which 
device values cannot be collected.

➟10.18.5 [File Transfer Setting] dialog

(6) Duration of logging interruption when logging data is saved
If logging data is saved also in a Unicode text file or CSV file, the duration of logging interruption will be longer than when 
the data is saved only in a binary file (*.G2L).
To shorten the duration of logging interruption, save data only in a binary file (*.G2L) and convert the file to a Unicode 
text file or CSV file in GT Designer3 or in the utility.
GT21 does not support conversion of binary files (*.G2L) to Unicode text files or CSV files in the utility.

D0
D1
D2

Logging data of the GOT

120
140
160

200D100

D0
D1
D2

Logging data of the GOT

remains.120
140
160

200D100

D0
D1
D2

Controller device

120
140
160

200D100

Reading device 
values of the GOT

D0
D1
D2

Controller device

120
145
160

200

145

D100

A device value has been 
changed during reading.

Reading device 
values of the GOT

140

140
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(7) Timing at which processing is stopped or on hold
During processing, if a logging file receives another processing request, the latter processing may be stopped or on hold.

(a) Timing at which collecting device values is stopped or pauses
In the following cases, no device value is collected if the trigger condition is satisfied because collecting device values stops.
Depending on the data collection intervals, device values may not be collected correctly.

(b) Timing at which saving files or clearing the buffering area data is on hold
In the following case, saving files or clearing the buffering area data is on hold.

(8) Updating the display of a historical trend graph or historical data list
In the following cases, updating the display of a historical trend graph or historical data list is on hold.
• When saving logging data to a data storage or file server
• When clearing the logging data in the buffering area

(9) Files that must not be deleted (only in the file save mode)
In the file save mode, a number is added to the set file name.
Do not delete the following control data and temporary file.
If either of the following is deleted, logging is not executed normally.
• Control data
Files that do not have numbers in their name

• Temporary file
File that has number 0000 in its name

(10)When powering off, restarting, or resetting the GOT
The logging data in the buffering area is deleted.
Save the logging data beforehand by using the file creation trigger or the storage trigger as necessary.

(11)When the GOT is powered off before the storage trigger conditions are satisfied
In such a case, even though you have configured the setting to save data into a data storage or file server, the logging 
data in the buffering area will be lost and will not be saved into the data storage or file server for restoration.
On GT27, GT25, GT23, or GS25, use the SRAM power-failure backup function in combination so that the logging data 
in the buffering area can be saved into the SRAM user area before the storage trigger conditions are satisfied.

➟9.2.3 ■3 SRAM power-failure backup function

(12)Precautions for removing an SD card
When you open the SD card cover or turn off the SD card access switch, the files are saved automatically.
Before removing the SD card, make sure that the file saving is complete by checking one of the following conditions.

• The Drive Status Notification signal (system signal 2-2.b0, b1) is turned off.
• The SD card access LED is turned off.

➟9.2.6 [Logging] dialog
The save process may take a few minutes to complete.

Timing Measures

When saving logging data to a data storage or file 
server

Take one of the following measures.
• Change the setting of [Log Storage Number]

For the details, refer to the following.

➟9.2.2 ■3 Number of logging events and saving them to a file
• Use [Logging Notification Device] to prevent the trigger condition from being satisfied 

during writing.
• Set a longer time interval for collecting device values.

When clearing the logging data in the buffering area Make sure that the trigger condition is satisfied after the Buffer Historical Data Cleared 
device is turned on.

When logging data is accessed by the historical trend 
graph or historical data list display

Reduce the number of devices monitored by the historical trend graph or historical data 
list display.

When switching between screens (GT21 and GS21) Make sure that the trigger condition is satisfied after the screen switching is complete.

Timing Measures

When logging data is accessed by the historical trend 
graph or historical data list display

Reduce the number of devices monitored by the historical trend graph or historical data 
list display.
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(13)Logging file conversion by the utility
The logging data in the buffering area is deleted.
Save the logging data beforehand by using the file creation trigger or the storage trigger as necessary.

(14)Character code and conversion destination file
If a device comment or logging name contains any character other than ASCII and Shift JIS characters, convert the 
relevant file as shown below.

• Convert the file to Unicode text format.
• Turn on the Character Code for CSV Conversion signal (GS522.b2), and convert the file to CSV format.

(15)Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(16)Opening a CSV file by Microsoft Excel
When a Unicode text file or CSV file that has been created through the logging function is opened by Microsoft Excel, the 
standard style of Microsoft Excel is applied. Depending on the setting, data of logging date and others may be displayed 
in a style different from the actual setting. To check whether the display is different from the actual style or not, open the 
Unicode text file and the CSV file by a text editor. The style that the GOT has output can be checked.

(17)Time data in a CSV file and the interval for a logging trigger
After a logging file (*.G2L) is converted to CSV format, the time data will be stored with an accuracy of 1 second.
If the interval for the logging trigger is not set to an integral multiple of 10 (×100 ms), a time lag may exist between the 
interval and the time data in the CSV file.
Example) When the interval for the logging trigger is set to 11 (×100 ms)

(18)Logging data at a communication timeout
• Whether or not the missing logging data detection function is used, device values are not recorded at a communication 
timeout.
This also applies to the case where one logging setting (one logging ID) is used for logging the device values of multiple 
controllers connected.
Device values of the controllers communicating with the GOT are recorded. When a communication timeout (timeout 
error) occurs, device values of the relevant controller are not recorded.

• When a logging file (*.G2L) is converted to a CSV file, the unrecorded values are left blank.

Logging trigger
Interval: 11 (×100 ms)

Time data in the CSV file

Actual time

10:30:00 10:30:02
10:30:02.00010:30:00.900

1.1 seconds
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9.2.5 [Logging List] dialog

Displays the list of the logging settings and manages the settings.
Step 1 Select [Common] → [Logging] from the menu.
Step 2 The [Logging List] dialog appears.

1) [New] button
Sets logging newly.
Clicking this button displays the [Logging] dialog.

2) [Edit] button
Changes a selected logging setting.
Clicking this button displays the [Logging] dialog.

3) [Copy] button
Copies a selected logging setting.

4) [Paste] button
After clicking this button, set [Destination ID] of the copied logging setting. The copied data is pasted as the logging 
setting of the set logging ID in the logging list.

5) [Delete] button
Deletes a selected logging setting.

6) [Delete All]] button
Deletes all the logging settings.

7) [Close] button
Closes the [Logging List] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)

3)

2)

1)

5)

6)

7)
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9.2.6 [Logging] dialog

➟■1 [Destination] dialog (for saving a logging file)
■2 [Destination] dialog (for saving a CSV or TXT file)
■3 [Screen Selection] dialog

• When [How to store logging data] is set to [File]

• When [How to store logging data] is set to [Buffering area]

The following shows the reference section related to each setting item.
1) [Logging ID]

➟(1) Logging ID
2) [Set Target Device] button

➟(3) Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

4)

5)

1)

2)

6)
7)

11)
12)
13)

12)
13)

3)

4)

5)

1)

2)

11)

8)
9)
10)
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3) [How to store logging data]
➟9.2.3 ■1 Logging mode

• [File]
➟9.2.3 ■4 File save mode

• [Buffering area]
➟9.2.3 ■5 Buffer historical mode

4) [Logging Notification Device]
➟(1) Logging Notification device

5) [Retain the logging data stored in the buffering area even when the GOT is turned off(data 
retention)]

Not available to GT21 and GS21.
➟9.2.3 ■3 SRAM power-failure backup function

6) [Create a logging file at any desired time]
➟(1) Saving data

7) [File Creation Notification Device]
➟(7) Notify File Creation device (File Terminal Notification device)

8) [Delete all the histories]
➟(3) Buffer Historical Data Cleared device

9) [Notify when all the histories are deleted]
➟(3) Buffer Historical Data Cleared device

10) [Store logging data to the file]
➟(1) Saving data

11) [Output additional file]
➟(3) Saving logging data in Unicode text file format or CSV file format and displaying it with a personal 

computer
12) [Create a new historical trend graph] button

➟(1) Display by the historical trend graph or historical data list display
13) [Traditional Display] button

➟9.2.7 [Logging] dialog (traditional display)

The following setting items are not available in the standard display.
To set these items, switch the [Logging] dialog to the traditional display.
• [Full Notification Signal Device]
• [Buffer Full Alert Capacity]
• [Logging Count Device]
• [Use missing logging data detection function] (Not available to GT21 and GS21)
• [Writing Notification Device]
• [Writing Error Notification Device]
The set contents are held even after the display is switched.
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■1 [Destination] dialog (for saving a logging file)

Set the location to which a binary file (*.G2L) is saved.

1) [Drive Name]
Select a destination drive.
The following shows selectable items.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

2) [Folder Name]
Set the name of the folder where files are stored.
In the default setting, [Package Folder Name] selected from [Common] → [GOT Type Setting] is set as the folder 
name.

➟12.7 Restrictions for Folder Names and File Names used in GOT
3) [File Name]

Set the name of the files to be saved.
In the default setting, LOG□ is set for the file name. (□ indicates the logging ID.)

➟12.7 Restrictions for Folder Names and File Names used in GOT
4) [Add date information to the file name]

Adds the date (year, month, and day) and time (hour, minute, and second) to the file name when the file is saved.
The date and time information of the first event in the logging file is used.

5) [Specify the date/time format for file output]
Set the format of the date and time displayed in a Unicode text file or CSV file.
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings
6) [Specify the date/time format for file output]

Available to GT27, GT25, and GS25.
This item appears when [Drive Name] is set to [N:Network Drive].
Automatically creates a folder for each GOT to save logging files.
Each folder is named as the IP address of each GOT.

➟5.3.15 ■4 Creating a folder for each GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)

6)

3)
2)

1)

5)
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■2 [Destination] dialog (for saving a CSV or TXT file)

Set the location to which a Unicode text file or CSV file is saved.

1) [Output Type]
Select the file format to be additionally output.
The following shows selectable items.

• [Unicode Text]: Saves a binary file (*.G2L) and a Unicode text file.
• [CSV]: Saves a binary file (*.G2L) and a CSV file.

2) [Destination]
Select the save destination folder for the additionally output file.
The following shows selectable items.

• [Same as Logging File]
Saves the output file to the location to which the logging file is saved.

• [Change]
Saves the output file to a location different from the location to which the logging file is saved.
Set [Drive Name] and [Folder Name].

3) [Drive Name]
Select a destination drive.
The following shows selectable items.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

4) [Folder Name]
Set the name of the folder where files are stored.
In the default setting, [Package Folder Name] selected from [Common] → [GOT Type Setting] is set as the folder 
name.

➟12.7 Restrictions for Folder Names and File Names used in GOT
5) [File Name]

Displays the name of the logging file.
6) [Specify the date/time format for file output]

Available to GT27, GT25, and GS25.
This item appears when [Drive Name] is set to [N:Network Drive].
Automatically creates a folder for each GOT to save files.
Each folder is named as the IP address of each GOT.

➟5.3.15 ■4 Creating a folder for each GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)

6)

3)
2)

1)

5)
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■3 [Screen Selection] dialog

Select the screen in which a historical trend graph is placed.

1) [Screen Type]
Select the type of the screen in which a historical trend graph is placed.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Mobile Screen] (GT27, GT25, and GS25)

2) [Screen No.]
Set the number of the screen in which a historical trend graph is placed.
The setting range is [0] to [32767].
A target screen is selectable from among screen titles as well.
To place a historical trend graph on a new screen, select [A new screen will be created.] for the screen title.
Click the [Browse] button to select a screen in thumbnail view in the [Screen Image List] dialog.

• [Screen Type]
Select the type of a screen to be opened.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)
1)

Screen title

Screen image list

Jump
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9.2.7 [Logging] dialog (traditional display)

➟■1 [Basic] tab
■2 [Device] tab
■3 [File Save] tab

■1 [Basic] tab

Set the logging mode, logging trigger, and buffering area.

1) [Logging ID]
Set a logging ID for using the logging function.
The setting range is [1] to [32767].

➟9.2.3 ■8 Management of logging setting
2) [Logging Name]

Set a logging name.
Up to 32 characters can be set. A set logging name is displayed in a Unicode text file and CSV file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Logging Mode] is [Buffer Historical]

When [Logging Mode] is [File Save]

3)

2)1)

4)

5)
6)
7)

8)

9)
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3) [Logging Mode]
Select the logging mode.
For the details of the logging mode, refer to the following.

➟9.2.3 ■1 Logging mode

Item Description

[File Save]

• [Number of Files]:
Specify the number of files to be saved into a data storage or file server.
The setting range is [1] to [9999].
When more logging files than the specified number of logging files are saved, the old 
logging files are overwritten.
➟9.2.3 ■4 File save mode

• [Number of Logs a file (number of items)]:
Set the number of events to be saved to a logging file.
The setting range is [1] to [65500].
Specify a value equal to or larger than the value set for [Log Storage Number].

• [File Terminal Trigger]:
Set the file creation trigger to start saving logging data to a file at an intended timing.
➟6.1.2 How to set devices

• [File Terminal Notification Device]:
Set the Notify File Creation device to notify that logging data is being saved upon turning 
on [File Terminal Trigger] (file creation trigger).
This item is available only when [File Terminal Trigger] is enabled.
➟6.1.2 How to set devices

[Buffer Historical]

• [Buffer Save]:
Set whether to save the logging data in the buffering area into a data storage or file 
server.
To not to save the logging data into a data storage or file server, select [No].
The data is not saved to a file, and the logging does not pause. Select [No] for the high-
speed logging.
To save the logging data into a data storage or file server, select [Yes].
The logging data can be restored from the data storage or file server upon turn-on of the 
GOT.
To save a backup of the logging file to be overwritten, select [Yes (auto backup when 
saving)].
If the logging data is corrupted, the data in the backup file is read.

• [Action When Buffer is Full]
Select an action when the number of logging data points stored in the buffering area 
reaches [Log Storage Number].
When [Delete old data] is selected, the oldest data is deleted and new logging data is 
added.
When [Add no item] is selected, no device value is collected even though another trigger 
condition is satisfied.

• [Full Notification Signal Device]
Set a device for notifying that the available space of the buffering area for saving logging 
data falls below the setting of [Buffer Full Alert Capacity].
➟9.2.3 ■5 Buffer historical mode

• In [Buffer Full Alert Capacity], set the timing (the number of currently available logging 
data points that can be saved: 0 to 255) to notify that the available space of the buffering 
area is small. If the number of currently available logging data points falls below this 
setting, [Full Notification Signal Device] is turned on.

• [Buffer Historical Data Clear]:
Set a device for deleting the logging data temporarily saved in the buffering area.
➟9.2.3 ■5 Buffer historical mode

• [Buffer Historical Data Clear Alert]:
Set a device for notifying that clearing the buffering area is completed using [Buffer 
Historical Data Clear].
9 - 188 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.2 Collecting Device Data ([Logging])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

4) [Logging Trigger]
Click the [Trigger Setting] button to display the [Trigger Setting] dialog and set the conditions to collect device values.

5) [Logging Notification Device]
Set a device for notifying that the device values of a controller are being collected to the buffering area.

➟9.2.3 ■2 Device
6) [Logging Count Device]

Set a device for notifying the number of collection times of device values after the GOT is started.
➟9.2.3 ■2 Device

7) [Use missing logging data detection function]
Not available to GT21 and GS21.
Enables the missing logging data detection function.

➟9.2.3 ■9 Missing logging data detection function
8) [Buffering]

9) [Display the standard setting] button
Switches the [Logging] dialog to the standard display.
The set contents are held even after the display is switched.

➟9.2.6 [Logging] dialog

• [Trigger Type]
Select a trigger type for logging.
The following shows selectable items.
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]

• [Trigger Device]
When selecting [Rise], [Fall], [Rise/Fall], [ON Sampling], or [OFF Sampling] 
for [Trigger Type], set a device as the trigger condition for logging.

• [Sampling]
When selecting [Sampling], [ON Sampling], or [OFF Sampling] for [Trigger 
Type], set the cycle for logging.
The setting range depends on the GOT model.

• GT27, GT25, GT23, GT SoftGOT2000, and GS25: [1] to [36000]
• GT21 and GS21: [5] to [36000]

Item Description

[Retain data in the embedded memory in GOT 
even when the power goes off (The battery 
will be required)]

Not available to GT21 and GS21.
Select this item to save the logging data in the buffering area to the SRAM user area.
Up to 20 logging settings can be configured with the SRAM power-failure backup function 
enabled.

➟9.2.3 ■3 SRAM power-failure backup function

[Log Storage Number] Set the number of logging data points temporarily saved in the buffering area. 
The setting range is [1] to [32767].

When [Trigger Type] is set to [Rise]

When [Trigger Type] is set to [Sampling]

When [Trigger Type] is set to [ON Sampling]

[Sampling]
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■2 [Device] tab

Set the target device for collection.

Selecting Unicode for the character code of the target device for collection
Available to GT27, GT25, GT23, GT SoftGOT2000, and GS25.
When [Character Code] is set to [Unicode] for a target device, if you specify the device for a text display, text 
input, or text print object, configure the settings in the object setting dialog as shown below.
(1) When [Storage Order] is set to [Low-->High] in the [Logging] dialog

• Select [Unicode] for [Character Code] in the [Device/Style] tab or in the [Text Print] dialog.
• Select [Display in order of High -> Low] in the [Extended] tab or in the [Text Print] dialog.

(2) When [Storage Order] is set to [High-->Low] in the [Logging] dialog
• Select [Unicode] for [Character Code] in the [Device/Style] tab or in the [Text Print] dialog.
• Deselect [Display in order of High -> Low] in the [Extended] tab or in the [Text Print] dialog.

1) [Block Number]
Set the number of blocks of the logging setting.

➟9.2.3 ■8 Management of logging setting
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [250].

• For GT21 and GS21
The setting range is [1] to [20].

2) [File Output Attribute]
Select this item to change the style of the device value that is to be output to a Unicode text file or CSV file.
After selecting this item, set [File Output Attribute] on the right side of [Device Comment].
This setting is available only when [File Save] is selected for [Logging Mode].

3) [Character Code]
Select a character code.
The following shows selectable items.

• [ASCII]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

13)

7)6)5) 10) 11) 12)9)8)

4)3)2)

14)
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• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]

4) [Storage Order]
Select the order in which character codes are stored.
The following shows selectable items.

• [Low-->High]
• [High-->Low]

5) [Insert Block] button
Inserts a block.
Select a column when inserting a block.

6) [Cut] button
Cuts a selected item.
This operation can also be performed from the right-click menu.

7) [Copy] button
Copies a selected item.
This operation can also be performed from the right-click menu.

8) [Paste] button
Pastes a selected item.
This operation can also be performed from the right-click menu.

9) [Clear] button
Clears the device comment when [Device Comment] is being selected.
Returns the number of displayed digits to the initial value when [Digits] is being selected.

10) [Delete] button
Deletes a selected line setting.

11) [Import] button
Imports the setting edited in a Unicode text file or CSV file to GT Designer3.

12) [Export] button
Saves the setting in the [Device] tab with a Unicode text or CSV file.
You can edit the exported file in spreadsheet software and others.
The edited file can be imported with GT Designer3.
The following shows the file format of the exported file.

When importing or exporting files in the multiple-language input environment, use Unicode text files.
The characters of multiple languages can be imported or exported normally by using Unicode text files.
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13) Device list
Lists the device values to be collected.

Item Description

[Device]
Set devices that are targets of the logging function.

➟6.1.2 How to set devices

[Device Type]

Select the data type of the device to be set.
The following shows selectable items.
• [Bit]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]
• [String]

[Points]

Set the number of devices to be collected in block units.
Devices starting from the start device are set sequentially for the set number.
The maximum number of devices that can be set depends on the setting of [Device Type].
• [Bit]: [1]
• [Signed BIN16], [Unsigned BIN16], [Signed BIN8], [Unsigned BIN8] [BCD16], or [String]: [1] to 

[250]
• [Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)]: [1] to [125]
• [Signed BIN64], [Unsigned BIN64], [BCD64], or [Real(64bit)]: [1] to [62]

[Character Count (one-byte)] 
([Character Count] when [Unicode] 
is selected for [Character Code])

Maximum number of characters to be collected.
This item is displayed when [String] is selected for [Device Type].
The settings of [Points] and [Character Code] determine the setting value.
• When [Unicode] is selected for [Character Code]

The maximum number of characters equals the value in [Points].
• When an item other than [Unicode] is selected

The maximum number of characters equals the value in [Points] multiplied by 2.
A two-byte character is counted as two characters.

[Device Comment]

Set a device comment.
Up to 32 characters can be set.
A set device comment is displayed in a Unicode text file and CSV file.
The column width can be adjusted to display the whole set device comment.

Extend the column width.
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14) [Display the standard setting] button

Switches the [Logging] dialog to the standard display.
The set contents are held even after the display is switched.

➟9.2.6 [Logging] dialog

(1) Relationship between the settings of [Device Type], [Display Type], and [Digits]
The selectable items for [Display Type] vary depending on the setting of [Device Type].
The setting range of [Digits] also varies depending on the setting of [Display Type].

[File Output Attribute]

Set the style of the device value that is to be output to a Unicode text file or CSV file.
Select [File Output Attribute] on the right side of [Block Number] to set the style.
• [Display Type]:

Select the data display type.
The setting range depends on the setting of [Device Type].

➟(1) Relationship between the settings of [Device Type], [Display Type], and 
[Digits]

• [Digits]:
Set the number of the digits displayed.
The setting range depends on the setting of [Display Type].
If the number of the digits of a collected value exceeds the number of set digits, the value is output 
intact.
When [Display Type] is set to [String], if a collected character string contains a null character in 
the range of the set number of digits, the characters preceding the null character are displayed.
When the number of characters collected is less than that of the set digits, spaces are added.

➟(1) Relationship between the settings of [Device Type], [Display Type], and 
[Digits]

• [Real Expression]:
Select the expression type of the real number.
Set this item when [Real] is selected for [Display Type].
The following shows selectable items.
• · [Exponential Expression]
• · [Fixed Decimal]
Example) When the device stores 123.4567 and [Decimal Point] is set to 3
• · Display using [Exponential Expression]: 1.235E+002 (The value in the exponential expression 
is rounded off to the third decimal place.)
• · Display using [Fixed Decimal]: 123.457 (The value is rounded off to the third decimal place.)
When [Device Type] is set to an item other than [Real], [Real Expression] is fixed to [Fixed 
Decimal].
The value set for [Decimal Point] is handled as the number of decimal places.
Example) When the device stores 12345 and [Decimal Point] is set to 2
Device value output to a file: 123.45 (The last two digits of the value are handled as the decimal 
places.)

• [Decimal Point]:
Set the number of digits of decimal numbers.
Set this item when [Real] is selected for [Display Type].
The setting range is [0] digits to [30] digits.

• [Fill with 0]:
Select this item to display 0 before the device value.
When the collected device value is 125 and [Digits] is 6, 000125 is displayed with this item 
selected.

Item Description

[Device Type] [Display Type] Setting range of [Digits]*1

[Bit]
[Bin] [1]

[Bit] [3]

[Signed BIN16]

[Signed Dec] [1] to [21]

[Hex] [4]

[Octal] [6]

[Bin] [16]

[Real] [1] to [32]

[Unsigned BIN16]

[Unsigned Dec] [1] to [21]

[Hex] [4]

[Octal] [6]

[Bin] [16]

[Real] [1] to [32]
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*1 When [Real Expression] is set to [Fixed Decimal], the value set for [Digits] is handled as the number of digits of the integer 
portion.
The sum of the values set for [Digits] and [Decimal Point] must be 30 or less.

[Signed BIN32]

[Signed Dec] [1] to [21]

[Hex] [8]

[Octal] [11]

[Bin] [32]

[Real] [1] to [32]

[Unsigned BIN32]

[Unsigned Dec] [1] to [21]

[Hex] [8]

[Octal] [11]

[Bin] [32]

[Real] [1] to [32]

[Signed BIN64]

[Signed Dec] [1] to [21]

[Hex] [16]

[Real] [1] to [32]

[Unsigned BIN64]

[Unsigned Dec] [1] to [21]

[Hex] [16]

[Real] [1] to [32]

[Signed BIN8]

[Signed Dec] [1] to [21]

[Hex] [2]

[Octal] [3]

[Bin] [8]

[Real] [1] to [32]

[Unsigned BIN8]

[Unsigned Dec] [1] to [21]

[Hex] [2]

[Octal] [3]

[Bin] [8]

[Real] [1] to [32]

[BCD16]
[Unsigned Dec] [1] to [21]

[Real] [1] to [32]

[BCD32]
[Unsigned Dec] [1] to [21]

[Real] [1] to [32]

[BCD64]
[Unsigned Dec] [1] to [21]

[Real] [1] to [32]

[Real(32bit)] [Real] [1] to [32]

[Real(64bit)] [Real] [1] to [32]

[String] [String] [1] to [500]

[Device Type] [Display Type] Setting range of [Digits]*1
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■3 [File Save] tab

Configure the settings to save the logging data in the buffering area into a data storage or file server.
This tab appears in the following cases.
• When the file save mode is selected
• When [Buffer Save] is enabled for the buffer historical mode

1) [File Access]
Set the file that stores logging data.

Item Description

[Drive Name]

Select a destination drive.
The following shows selectable items.
• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

[Folder Name]

Set the name of the folder where files are stored.
In the default setting, [Package Folder Name] selected from [Common] → [GOT Type 
Setting] is set as the folder name.

➟12.7 Restrictions for Folder Names and File Names used in GOT

[File Name]
Set the name of the files to be saved.
In the default setting, LOG□ is set for the file name. (□ indicates the logging ID.)

➟12.7 Restrictions for Folder Names and File Names used in GOT

[Add date information to the file name]
Adds the date (year, month, and day) and time (hour, minute, and second) to the file name 
when the file is saved.
The date and time information of the first event in the logging file is used.

[Separate destinations to the file name]

Available to GT27, GT25, and GS25.
This item appears when [Drive Name] is set to [N:Network Drive].
Automatically creates a folder for each GOT to save logging files.
Each folder is named as the IP address of each GOT.

➟5.3.15 ■4 Creating a folder for each GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
4)

6)

5)

7)
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2) [Store Trigger]
Click the [Trigger Setting] button to display the [Trigger Setting] dialog and set the conditions to save data in the 
buffering area to a logging file.

➟6.2.2 Setting Trigger Types
3) [Writing Notification Device]

Set a device for notifying that the logging data is being saved.
➟9.2.3 ■2 Device

4) [Writing Error Notification Device]
Set a device for notifying an error when saving the logging data has failed.

➟9.2.3 ■2 Device
5) [Specify the date/time format for file output]

Set the format of the date and time displayed in a Unicode text file or CSV file.
Click the [...] button, and set the date/time formats in the [Date/Time Setting] dialog.

➟6.3.2 Date/time format settings
6) [Output additional file]

Set these items to save a Unicode text file or CSV file when the logging data is saved.
➟12.9 Precautions for Using Unicode Text File

7) [Display the standard setting] button
Switches the [Logging] dialog to the standard display.
The set contents are held even after the display is switched.

➟9.2.6 [Logging] dialog

9.2.8 [Logging File Conversion] dialog

A binary file (*.G2L) stored in the data storage with GT Designer3 can be converted into a Unicode text file or CSV file. Since 
the file is converted with GT Designer3, converting is processed without any load on the GOT.

Step 1 Store the binary file by either of the following methods.
• Transferring with GT Designer3

Select [Communication] → [Read from GOT...] from the menu to transfer a file to the personal computer.
• Storing by using the data storage

Save logging data to the data storage and read the data in the data storage using the personal computer.
Step 2 Select [Tools] → [Resource Data Conversion] → [Logging File] from the menu in GT Designer3 to display 

the [Logging File Conversion] dialog.
Set the following items and convert a binary file into a Unicode text file or a CSV file.

Item Description

[Output additional file]

Select the file format to be additionally output.
• [Unicode Text]: Saves a binary file (*.G2L) and a Unicode text file.
• [CSV]: Saves a binary file (*.G2L) and a CSV file.

When an additional file is output, the duration of logging interruption may be longer.

[Save Destination]

Select the save destination folder for the additionally output file.
• [Same as Logging File]:

Saves the output file to the location to which the logging file is saved.
• [Change]:

Saves the output file to a location different from the location to which the logging file is 
saved.
Set [Drive Name], [Folder Name], and [Separate destinations for each GOT].
The setting method is the same as the one for [File Access] to store a logging file.
[File Name] displays the name of the logging file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1) [Source of Conversion]

2) [Destination File]

9.2.9 Relevant settings

Set the relevant settings other than the specific settings for the logging function as required. The following shows the 
functions that are available by the relevant settings.

■1 GOT internal device
➟1.2.7 ■1 (1) GOT internal devices (GB, GD, and GS)

*1 If the setting for saving the logging data in the buffering area to the data storage is not configured (if [Buffer Save] in the logging 
setting is set to [No]), the data cannot be saved to the data storage.

Item Description

[Type] Displays the file type of the conversion source file.

[Path] Specify a path of the conversion source file.

[Convert all logging files in the same path]

Check this item to convert all files (G2L files only) that have the same path. When the 
conversion is executed after this item is checked, a conversion log is automatically created 
to the specified path. You can check the full path of the converted files, the conversion 
results (OK, NG), or the creation date of files in the conversion log.

Item Description

[Type]

Select a file type of a file to be created after the conversion. 
The following shows selectable items.
• [CSV]
• [Unicode Text]

[Path] Displays the path of a file to be saved at the destination, which is the same path as the one 
of the conversion source file.

1)

2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Saving the data in the buffering area to data storage (Buffering And File Access Control: Forcefully Save 
Buffered Data signal)*1 GS520.b0

Changing the character code to Unicode when a binary file is converted to CSV format
(Read device)

GS522.b2
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9.3 Executing the Batch Write or Batch Read on Multiple Devices 
([Recipe])

9.3.1 Overview of the recipe function

The recipe function collectively writes or reads values to or from multiple devices.

■1 Writing device values
Preset values are written to multiple devices.
You can set multiple combinations of device values (records) to be written.
Example) Writing the values of record 1

■2 Reading device values
Values are read from multiple devices.
The read values are saved as the values of a record in a data storage or the SRAM user area.
Example) Saving the read device values in record 2

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device Device value

D12 500 → 350

D11 750 → 250

D10 250 → 150

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100 → 500

300 → 750

500 → 250
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9.3.2  Specifications of the recipe

➟■1 Contents of a recipe setting
■2 Types of writing and reading methods
■3 Recipe data
■4 Specifications of the recipe file

■1 Contents of a recipe setting

A recipe setting consists of target devices, combinations of values to be written (records), trigger devices, and other fields.
Device values are read or written in units of recipe settings.
Each recipe setting has a recipe number used to specify the recipe data to be written or read.
The maximum number of recipe settings depends on the GOT model.

Set recipe settings in the [Recipe] dialog.
➟9.3.7 [Recipe] dialog

For the details of blocks, devices, and records, refer to the following.
➟(1) Block
(2) Device
(3) Record

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Number of recipe settings per project Setting range of recipe No.

GT27, GT25, GT23, GT SoftGOT2000, GS25 Up to 2500 settings
1 to 32767

GT21, GS21 Up to 256 settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Block

Record
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(1) Block
Target devices are set in units of blocks.
Up to 2048 blocks can be set in one recipe setting.
Set target devices, device types, and number of devices by block.
To set different types of devices in one recipe setting, arrange the devices by block according to their type.
To set consecutive devices as target devices in one block, set the number of devices.
Example) Setting example of blocks

(2) Device
Multiple devices to which values are written, or from which values are read.
The following shows the maximum number of target devices that can be set.

(a) Number of devices per recipe setting
The number of devices that can be set per recipe setting (the total of all blocks) depends on the number of records to be set.

• 256 records or less: 65536 devices
• 257 records or more: 8192 devices

(b) Number of devices per block
The number of devices that can be set per block depends on the number of records to be set.
However, when [Device Type] is [String], up to 2048 devices can be set regardless of the number of records.

• 256 records or less: 32768 devices
• 257 records or more: 8192 devices

(c) Maximum number of devices per project
When recipe files are saved in drive C or D of GT21 or GS21, the numbers of devices and records are restricted as follows.

• The number of devices per recipe setting is calculated by using the expression "the number of devices × the number 
of records". The total number of devices in all recipe settings must be 8000 or less.

Block [Device] [Device Type] [Points]

Block 1
[D1000] 
Three consecutive devices (D1000 to D1002) 
are set as target devices.

[Signed BIN16] 3

Block 2
[D2000] 
Two 32-bit-equivalent consecutive devices 
(D2000 to D2003) are set as target devices.

[Signed BIN32] 2

Block 3
[D3000] 
Five consecutive devices (D3000 to D3004) are 
set as target devices.

[String] 5

Block 1

Block 3

Block 2
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(3) Record
Values of target devices are managed in units of records.
Up to 2000 records can be set in one recipe setting.

(a) When writing device values
Specify values to be written to devices in units of records.
One record can be specified for one write.
Example) Writing the values of record 1

(b) When reading device values
The values read from devices are saved as one record.
One record can be specified for one read.
Example) Saving the read device values in record 2

■2 Types of writing and reading methods

(1) Writing methods
The following writing methods are available when the GOT writes the values of a record into the target devices of a 
controller.

(a) Trigger device per project
Specify a recipe number and a record number with applicable devices to write the values of the record into the target 
devices of a controller.
The trigger device is shared among all the recipe settings in one project.
The trigger condition is satisfied only by turning on the trigger device.
For the setting and operating procedures, refer to the following.

➟9.3.3 ■1 (1) Writing device values using a trigger device per project

(b) Trigger device per recipe setting
Specify a record number with an applicable device to write the values of the record into the target devices of a controller.
(When the recipe setting has only one record, the record number does not need to be specified.)
Up to two trigger devices can be set. The following setting can be configured: Device values are written only when both 
of the trigger conditions are satisfied.
Each trigger condition is satisfied by turning on or off a trigger device.
For the setting and operating procedures, refer to the following.

Device Device value

D12 500 → 350

D11 750 → 250

D10 250 → 150

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100 → 500

300 → 750

500 → 250

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟9.3.3 ■1 (2) Writing device values using a trigger device per recipe setting

(c) Recipe operation window
Specify a recipe file in the recipe operation window to write the values of the record into the target devices of a controller.
To write device values in the recipe operation window, recipe files are necessary.
For the setting and operating procedures, refer to the following.

➟9.3.3 ■1 (3) Writing device values in the recipe operation window

(d) Recipe display (record list)
Use a key code switch to write a record selected on the recipe display (record list).
This method requires the applicable key code switch.
For the setting and operating procedures, refer to the following.

➟8.14 Placing a Recipe Display (Record List)
8.2.11 [Key Code Switch] dialog

(2) Reading methods
The following reading methods are available when the GOT reads values from the target devices of a controller into a 
record.

(a) Trigger device per project
Specify a recipe number and a record number with applicable devices to read values from the target devices of a 
controller into the record.
The trigger device is shared among all the recipe settings in one project.
The trigger condition is satisfied only by turning on the trigger device.
For the setting and operating procedures, refer to the following.

➟9.3.3 ■2 (1) Reading device values using a trigger device per project

(b) Trigger device per recipe setting
Specify a record number with an applicable device to read values from the target devices of a controller into the record.
(When the recipe setting has only one record, the record number does not need to be specified.)
Up to two trigger devices can be set. The following setting can be configured: Device values are read only when both of 
the trigger conditions are satisfied.
Each trigger condition is satisfied by turning on or off a trigger device.
For the setting and operating procedures, refer to the following.

➟9.3.3 ■2 (2) Reading device values using a trigger device per recipe setting

(c) Recipe operation window
Specify a recipe file in the recipe operation window to read values from the target devices of a controller into the record.
To read device values, recipe files are necessary.
For the setting and operating procedures, refer to the following.

➟9.3.3 ■2 (3) Reading device values in the recipe operation window

(d) Recipe display (record list)
Use a key code switch to read a record selected on the recipe display (record list).
This method requires the applicable key code switch.
For the setting and operating procedures, refer to the following.

➟8.14 Placing a Recipe Display (Record List)
8.2.11 [Key Code Switch] dialog

■3 Recipe data

The recipe data includes the target devices, records, and device comments based on a recipe setting.
The records in the recipe data are subjected to reading and writing.
You can save the recipe data into a data storage or the SRAM user area.
Set the save destination in the [Recipe] dialog ([Basic] tab).

➟9.3.7 ■1 [Basic] tab
The recipe data is handled differently depending on the save destination setting.

• When [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read and write)]
➟(1) Saving the data into a data storage

• When [Recipe Data Save Location] is set to [Embedded Memory in GOT (read and write)]
➟(2) Saving the data into the SRAM user area

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• When [Recipe Data Save Location] is set to [Not save (record value write only)]
➟(3) Not saving the data

(1) Saving the data into a data storage
The recipe data is saved to a recipe file in the specified drive (data storage) of the GOT.
The records in the recipe file are subjected to reading and writing.
To edit the recipe data, transfer the recipe file to a personal computer.
The following shows the available drives of the GOT.

• Drive A
• Drive B
• Drive C
• Drive D
• Drive E
• Drive F
• Drive G
• Drive X (current drive)

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

Some GT21 and GS21 models have drive C or D.
No data storage is required to use drive C or D.

(2) Saving the data into the SRAM user area
Not available to GT21 and GS21.
The recipe data is saved into the SRAM user area of the GOT.
No recipe file is created.
The records of the recipe data in the SRAM user area are subjected to reading and writing.
In this case, the following operations are not available.

• Operations in the recipe operation window
The SRAM user area space is limited.
Only the following fields are saved accordingly. For the other fields, the recipe settings in the project are used.

• Record name
• Record attribute
• Values of the record

To use device comments or other fields, or large amounts of recipe data, save the recipe data to a recipe file in the data 
storage.

For the details of the SRAM user area, refer to the following.
➟9.3.3 ■10 Saving recipe data into the SRAM user area

(3) Not saving the data
The recipe data is not saved.
No recipe file is created.
The records in a recipe setting in the project are subjected to writing.
In this case, the following operations are not available.

• Writing device values in the recipe operation window
• Reading device values

Select not to save the recipe data for write operations only.
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■4 Specifications of the recipe file

➟(1) Recipe file
(2) Recipe file format
(3) Configuration of the recipe file

(1) Recipe file
A recipe file contains recipe data.
The records in the recipe file are subjected to reading and writing, and the contents of the file are editable.
Set whether to use the recipe file per recipe setting.
To use a recipe file, set [Recipe Data Save Location] to [Data Storage (Recipe File)(read and write)] in the [Recipe] dialog 
([Basic] tab).

➟9.3.7 ■1 [Basic] tab
A recipe file is automatically created when all of the following conditions are satisfied at writing or reading.

• [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read and write)] in the [Recipe] dialog.
• The writing or reading method is using a trigger device per project or per recipe setting.
• No recipe file exists.

For the behavior when a recipe file is used, refer to the following.
➟9.3.2 ■3 (1) Saving the data into a data storage

(2) Recipe file format
The following file formats are available for recipe files.

(a) Binary format (*.G2P)
A recipe file is created in binary format (*.G2P).
One file is created for one recipe setting.
To edit such a recipe file on a personal computer, convert it to CSV or Unicode text format.
In this case, unlike a recipe file originally in CSV or Unicode text format, the file still contains multiple records after its format 
is converted.

(b) CSV format (*.CSV)
A recipe file created in CSV format (*.CSV) is used intact.
To edit such a file on a personal computer, the file format conversion is not required.
One recipe file contains one record only. Recipe files are created for each record.
The record number is added to the end of the file name.
Example) Recipe file with record number 3: ARP00001_0003.CSV

(c) Unicode text format (*.TXT)
A recipe file in Unicode text format (*.TXT) is used intact.
To edit such a file on a personal computer, the file format conversion is not required.
One recipe file contains one record only. Recipe files are created for each record.
The record number is added to the end of the file name.
Example) Recipe file with record number 3: ARP00001_0003.TXT

For how to set the file format, refer to the following.
➟9.3.7 ■1 [Basic] tab

For the precautions for editing a CSV file or Unicode text file on a personal computer, refer to the following.
➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File
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(3) Configuration of the recipe file
The following shows the configuration of a recipe file in CSV or Unicode text format.
To edit a recipe file in binary format (*.G2P) on a personal computer, convert it to CSV or Unicode text format.
Only the following items can be edited.

• Record name
• Record attribute
• Record
• Device comment (when edit is allowed in the recipe setting)

1) Recipe No.
Recipe number of a source recipe setting

2) Number of characters in the device comment to be converted
Number of characters in a target device comment when the recipe file is converted from CSV or Unicode text format 
to binary format (*.G2P).
This item is output when [Include device comments in conversion target] is selected in the [Basic] tab in the [Recipe] 
dialog.

3) Recipe name
Name of a source recipe setting

4) Total number of devices
Total number of devices in a source recipe setting

5) Number of records
Number of records in a source recipe setting

6) Order of date and time
Order of date and time output when the records are updated

7) Time zone
Difference between Greenwich Mean Time and local time

8) Time information
Information on time data

• L: Local time
9) Record No.

Record number of each record
10) Record name

Each record name
Up to 32 characters can be set.

11) Record attribute
Record attribute of each record.
The following shows the items to be selected.

• Blank column: Device values can be changed.
• P: Device values cannot be changed.
• N: No device value

12) Record update time
Time at which the device values of a record are updated to the read ones

13) Line number
Line number of each line

1)
3)

4)
5)

6)
7)

8)

13) 14) 15) 16) 17)

9)
10)

11)
12)

18)

2)
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14) Device comment
Comment for the device in each line.
Up to 32 characters can be set.
Set the number of characters applied at the conversion in [Maximum number of characters] in the [Basic] tab of the 
[Recipe] dialog.

15) Device type
Type of the device in each line

• [BIT]: Bit
• [BIN8]: Signed 8-bit binary
• [BIN8_Unsigned]: Unsigned 8-bit binary
• [BIN16]: Signed 16-bit binary
• [BIN16_Unsigned]: Unsigned 16-bit binary
• [BIN32]: Signed 32-bit binary
• [BIN32_Unsigned]: Unsigned 32-bit binary
• [BIN64]: Signed 64-bit binary
• [BIN64_Unsigned]: Unsigned 64-bit binary
• [BCD16]: 16-bit binary-coded decimal
• [BCD32]: 32-bit binary-coded decimal
• [BCD64]: 64-bit binary-coded decimal
• [REAL]: Real numbers (32 bits)
• [REAL64]: Real numbers (64 bits)
• [STRING]: Character string

16) Display format
Display format of the device in each line

• [BIT]: Bit
• [DEC]: Signed decimal
• [UNSIGNED_DEC]: Unsigned decimal
• [REAL_FLOAT]: Real number (exponential expression)
• [REAL_FIX]: Real number (fixed-point number)
• [ASC]: ASCII code
• [UNI]: Unicode
• [SJIS]: Shift JIS code
• [KS]: KS (Korean)
• [GB]: GB (Simplified Chinese)
• [BIG5]: BIG5 (Traditional Chinese)
• [BIN]: Binary number
• [OCT]: Octal number
• [HEX]: Hexadecimal number

17) Number of devices
Number of devices in each line

18) Record
Device values of each record.
Edit the value according to the device type.
Multiple records are managed in a recipe file, which is converted from binary format (*.G2P).
Only one record is managed in a recipe file, which is originally created in CSV or Unicode text format.
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9.3.3 How to use the recipe

➟■1 Writing device values
■2 Reading device values
■3 Transferring recipe files to edit
■4 Converting a recipe file
■5 Operations with the recipe display (record list)
■6 Operations in the recipe operation window and utility
■7 Using a GOT1000 advanced recipe file (*.G1P)
■8 Operations with GOT special registers (GS) (Recipe special control)
■9 Link with the recipe display (record list) by using GOT special registers
■10 Saving recipe data into the SRAM user area

The following shows how to set a recipe setting.
Step 1 Click [Common] → [Recipe] → [Recipe] from the menu to display the [Recipe List] dialog.

➟9.3.6 [Recipe List] dialog

Step 2 Perform one of the following operations to display the [Recipe] dialog.
• Click the [New] button.
• Select a recipe setting and click the [Edit] button.
➟9.3.7 [Recipe] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 3 Set necessary items in each tab in the [Recipe] dialog, and click the [OK] button to complete the recipe 
setting.
• [Basic] tab

Set the recipe number and the trigger device for writing or reading values per recipe setting.
• [Device] tab

Set the target device and record.
• [File Save] tab

Set the desired file format and save destination when converting a binary recipe file (*.G2P) by using a trigger 
device.

➟9.3.7 ■1 [Basic] tab
　 9.3.7 ■2 [Device] tab
　 9.3.7 ■3 [File Save] tab

■1 Writing device values

➟(1) Writing device values using a trigger device per project
(2) Writing device values using a trigger device per recipe setting
(3) Writing device values in the recipe operation window
(4) Writing device values using the recipe display (record list)

(1) Writing device values using a trigger device per project

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 

Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

Step 2 Select [External Control Device], set a device, and click the [OK] button.
Consecutive devices, starting from the device set in [External Control Device], are automatically set in [Recipe 
No. Storage Device] and [Record No. Storage Device].
Bit 0 of the device set in [External Control Device] is set as the write trigger device (per project).
➟9.3.5 ■1 [External Control Device]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Operation on the GOT
Input values into the Recipe No. Storage device and the Record No. Storage device respectively, and then satisfy the 
condition of the write trigger.
The values of the specified record will be written into the target devices.
Example) Writing record 3 in recipe No. 5

• [External Control Device]: D1000
• [Recipe No. Storage Device]: D1001 = 5
• [Record No. Storage Device]: D1002 = 3

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 5

Device Device value

D12 500 → 50

D11 750 → 70

D10 250 → 90

Turn on D1000.b0.

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 5
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(2) Writing device values using a trigger device per recipe setting

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe] from the menu to display the [Recipe List] dialog.

➟9.3.6 [Recipe List] dialog

Step 2 Perform one of the following operations to display the [Recipe] dialog.
• Click the [New] button.
• Select a recipe setting and click the [Edit] button.
➟9.3.7 [Recipe] dialog

Step 3 Set the following items in the [Basic] tab, and click the [OK] button.
• [Recipe Data Save Location]

Set the save destination of the recipe data.
• [Write Trigger 1]

Select this item to set a device and its trigger condition (ON or OFF).
• [Write Trigger 2]

Set this item as required.
• [Record No. Device]

Set a device.
When the number of records is one, record 1 is always specified, and thus no setting is required.
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(b) Operation on the GOT
Input a value into the Record No. device, and then satisfy the condition of the write trigger.
The values of the specified record will be written into the target devices.
Example) Writing record 2 in recipe No. 3

• [Write Trigger 1] of recipe No. 3: X1000 (Trigger condition: ON)
• [Record No. Device] of recipe No. 3: D1100 = 2

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 3

Device Device value

D12 500 → 100

D11 750 → 300

D10 250 → 500

Turn on X1000.

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 3
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(3) Writing device values in the recipe operation window

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 

Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

Step 2 Select [Enable recipe file operation on the monitor], and click the [OK] button.
Step 3 To display the recipe operation window on the monitor screen, use a special function switch ([Switch Action]: 

[Recipe Information]).
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog

(b) Procedure on the GOT
Perform one of the following operations to display the recipe operation window.

• Touch a special function switch ([Switch Action]: [Recipe Information]).
• Touch the [Oper.] button on the [Recipe information] screen in the utility.

For the recipe operation window and the operations in the utility, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(4) Writing device values using the recipe display (record list)

For the setting and operating procedures for the recipe display (record list), refer to the following.
➟8.14.2 How to use the recipe display (record list)

■2 Reading device values

➟(1) Reading device values using a trigger device per project
(2) Reading device values using a trigger device per recipe setting
(3) Reading device values in the recipe operation window
(4) Reading device values using the recipe display (record list)

(1) Reading device values using a trigger device per project

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 

Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 2 Select [External Control Device], set a device, and click the [OK] button.
Consecutive devices, starting from the device set in [External Control Device], are automatically set in 
[Recipe No. Storage Device] and [Record No. Storage Device].
Bit 1 of the device set in [External Control Device] is set as the read trigger device (per project).

➟9.3.5 ■1 [External Control Device]

(b) Operation on the GOT
Input values into the Recipe No. Storage device and the Recipe No. Storage device respectively.
Then, satisfy the condition of the read trigger.
The values of the specified record will be overwritten with the values read from the target devices.
Example) Reading device values and overwriting record 3 in recipe No. 5

• [External Control Device]: D1000
• [Recipe No. Storage Device]: D1001 = 5
• [Record No. Storage Device]: D1002 = 3

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 5

Device Device value

D12 500

D11 750

D10 250

Turn on D1000.b1.

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50→ 500

70→ 750

90 → 250

Recipe No. 5
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(2) Reading device values using a trigger device per recipe setting

(a) Setting in GT Designer3
Step 1 Click [Common] → [Recipe] → [Recipe] from the menu to display the [Recipe List] dialog.

➟9.3.6 [Recipe List] dialog

Step 2 Perform one of the following operations to display the [Recipe] dialog.
• Click the [New] button.
• Select a recipe setting and click the [Edit] button.
➟9.3.7 [Recipe] dialog

Step 3 Set the following items in the [Basic] tab, and click the [OK] button.
• [Recipe Data Save Location]

Set the save destination of the recipe data.
• [Read Trigger 1]

Select this item to set a device and its trigger condition (ON or OFF).
• [Read Trigger 2]

Set this item as required.
• [Record No. Device]

Set a device.
When the number of records is one, record 1 is always specified, and thus no setting is required.
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(b) Operation on the GOT
Input a value into the Record No. device.
Then, satisfy the condition of the read trigger.
The values of the specified record will be overwritten with the values read from the target devices.
Example) Reading device values and overwriting record 2 in recipe No. 3

• [Read Trigger 1] of recipe No. 3: X2000 (Trigger condition: ON)
• [Record No. Device] of recipe No. 3: D1100 = 2

(3) Reading device values in the recipe operation window

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 

Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

Step 2 Select [Enable recipe file operation on the monitor], and click the [OK] button.

Device Device value

D12 500

D11 750

D10 250

Device Record 1

D12 350

D11 250

D10 150

Record 2

100

300

500

Record 3

50

70

90

Recipe No. 3

Device Device value

D12 500

D11 750

D10 250

Turn on X2000.

Device Record 1

D12 350

D11 250

D10 150

Record 2

100 → 500

300 → 750

500 → 250

Record 3

50

70

90

Recipe No. 3
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Step 3 To display the recipe operation window on the monitor screen, use a special function switch ([Switch Action]: 
[Recipe Information]).
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog

(b) Procedure on the GOT
Perform one of the following operations to display the recipe operation window.

• Touch a special function switch ([Switch Action]: [Recipe Information]).
• Touch the [Oper.] button on the [Recipe information] screen in the utility.

For the recipe operation window and the operations in the utility, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(4) Reading device values using the recipe display (record list)

For the setting and operating procedures for the recipe display (record list), refer to the following.
➟8.14.2 How to use the recipe display (record list)

■3 Transferring recipe files to edit

➟(1) Transferring a recipe file using a data storage
(2) Transferring a recipe file directly between a personal computer and the GOT
(3) Importing a recipe file by using a special function switch (Recipe data operation)
(4) Exporting a recipe file by using a special function switch (Recipe data operation)

You can transfer recipe files to a personal computer to edit, and then transfer them back to the GOT to use.
The following shows how to transfer a recipe file between the GOT and a personal computer.
For a recipe file in CSV or Unicode text format, edit the file on a personal computer directly.
For a recipe file in binary format (*.G2P), convert the file to CSV or Unicode text format, and then edit it on a personal 
computer.
After editing a recipe file, convert the file back to binary format (*.G2P) and then use it on the GOT.
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

If the save destination of the recipe data is set to the SRAM user area, no recipe file will be created.
To edit the recipe data stored in the SRAM user area on a personal computer, export the data to a recipe file.

➟9.3.3 ■4 Converting a recipe file

For GT SoftGOT2000, you can manipulate the recipe files stored in virtual drives by using Windows Explorer or others.
For the structure of virtual drives of a GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

The following shows how to transfer a recipe file between the GOT and a personal computer.
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(1) Transferring a recipe file using a data storage

Install a data storage that contains a recipe file to a personal computer, and read the file.
Then, install the data storage that contains the edited recipe file to the GOT to use the file.

(2) Transferring a recipe file directly between a personal computer and the GOT

Connect a personal computer and the GOT to transfer recipe files between them.

For how to connect a personal computer and the GOT, refer to the following.
➟4.3.1 Connecting the personal computer to the GOT

For the settings of resource data writing or reading, refer to the following.
➟4.3.2 ■1 (2) Writing the resource data
　 4.3.2 ■3 (2) Reading the resource data

(3) Importing a recipe file by using a special function switch (Recipe data operation)

The behavior of the special function switch (Recipe data operation) varies depending on the recipe data save destination 
setting.

(a) When the save destination is set to the data storage (recipe file)
This operation is available for a recipe file in the binary format (*.G2P) only.
When you touch a special function switch ([Switch Action]: [Recipe Data Operation]), the recipe file (*.G2P) having the 
specified recipe number is overwritten with the data from the import source file.
The import source file must be in the binary format (*.G2P), CSV format (*.CSV), or Unicode text format (*.TXT).
When you use an import source file in the CSV format (*.CSV) or Unicode text format (*.TXT), the file is converted to the 
binary format and then saved on the GOT.
(The conversion source file is not deleted.)
When you use an import source file in the binary format (*.G2P), the file is saved without conversion.

Example) When importing a Unicode text file in drive E to a recipe file (*.G2P) in drive A

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) When the save destination is set to the SRAM user area
When you touch a special function switch ([Switch Action]: [Recipe Data Operation]), the recipe data in the SRAM user 
area is overwritten with the data from the import source file.
The import source file must be in the binary format (*.G2P), CSV format (*.CSV), or Unicode text format (*.TXT).

Example) When importing data from a Unicode text file in drive E into the recipe data in the SRAM user area

(c) When not saving the recipe data
The data of a recipe file cannot be imported.

(4) Exporting a recipe file by using a special function switch (Recipe data operation)

The behavior of the special function switch (Recipe data operation) varies depending on the recipe data save destination 
setting.

(a) When the save destination is set to the data storage (recipe file)
This operation is available for a recipe file in the binary format (*.G2P) only.
When you touch a special function switch ([Switch Action]: [Recipe Data Operation]), the recipe data having a specified 
recipe number is saved to a specified folder as a recipe file.
The export destination file must be in the binary format (*.G2P), CSV format (*.CSV), or Unicode text format (*.TXT).
When you specify the CSV format (*.CSV) or Unicode text format (*.TXT) for the export destination file, the export source 
file is converted to a specified file format and then saved on the GOT.
When you specify the binary format (*.G2P), the file is saved without conversion.

Example) When exporting a recipe file (*.G2P) in drive A to drive E

Special function switch
(Recipe data operation)

Drive E

*.TXT

Drive A

*.G2P

A Unicode text file is converted 
and then saved by overwriting 
a recipe file (*.G2P) in drive A.

Special function switch

(Recipe data operation)

Drive E

*.TXT

Overwriting the recipe data in 
the SRAM user area 

with the data of a recipe file

SRAM user area

Recipe data

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) When the save destination is set to the SRAM user area
When you touch a special function switch ([Switch Action]: [Recipe Data Operation]), the recipe data in the SRAM user 
area is saved to a recipe file in a specified folder.
The export destination file must be in the binary format (*.G2P), CSV format (*.CSV), or Unicode text format (*.TXT).

Example) When exporting the recipe data from the SRAM user area into the recipe file (*.TXT) in drive E

(c) When not saving the recipe data
The recipe data cannot be exported.

■4 Converting a recipe file

➟(1) Converting a recipe file using a trigger device per project
(2) Converting a recipe file in the recipe operation window
(3) Converting a recipe file in the utility
(4) Converting a recipe file with GT Designer3

The following shows how to convert the format of a recipe file.

(1) Converting a recipe file using a trigger device per project

Use a trigger device to convert a recipe file on the GOT.
Convert files one by one.
The behavior when the trigger condition is satisfied varies depending on the recipe data save destination setting.

(a) Setting in GT Designer3
Set a trigger device used for conversion in the common setting.
Set the file format and save destination of conversion destination files for each recipe setting.

Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 
Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

Special function switch
(Recipe data operation)

Drive E

*.TXT

Drive A

*.G2P

A recipe file (*.G2P) is converted
 into a Unicode text file 

and then saved to drive E.

Special function switch

(Recipe data operation)

Overwriting the recipe file 
in drive E with the recipe data 

in the SRAM user area

SRAM user area

Recipe data

Drive E

*.TXT
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Step 2 Select [External Control Device], set a device, and click the [OK] button.
Consecutive devices, starting from the device set in [External Control Device], are automatically set in 
[Recipe No. Storage Device] and [Record No. Storage Device].
Bit 8 of the device set in [External Control Device] is set as the Convert Recipe File signal, and bit 9 is set 
as the Reverse-convert Recipe File signal.

➟9.3.5 ■2 [External Notification Device]
Step 3 Select [Common] → [Recipe] → [Recipe] from the menu to display the [Recipe List] dialog.

➟9.3.6 [Recipe List] dialog

Step 4 Perform one of the following operations to display the [Recipe] dialog.
• Click the [New] button.
• Select a recipe setting and click the [Edit] button.

➟9.3.7 [Recipe] dialog
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Step 5 Set the following items in the [File Save] tab, and click the [OK] button.
• [Enable the file conversion external control]

Select this item.
• [Convert Format]

Select the file format to which a recipe file is converted.
• [Destination]

Set this item as required.
• [File Name Specification]

Set this item as required.

(b) Conversion operation (Recipe data save destination: data storage (recipe file))
Specify the recipe number of a target recipe file with an applicable device, and satisfy the condition of the conversion 
trigger.
The file format of the recipe file will be converted.
The conversion source file remains intact.
The trigger depends on the file format to which a recipe file is converted.

• To convert a recipe file from binary format (*.G2P) to the set format 
Turn on the Convert Recipe File signal (bit 8 of the external control device).

• To convert a recipe file from the set format to binary format (*.G2P) 
Turn on the Reverse-convert Recipe File signal (bit 9 of the external control device).

Example) Converting the recipe file (*.G2P) of recipe No. 5 to Unicode text format (*.TXT)
• [External Control Device]: D1000
• [Recipe No. Storage Device]: D1001 = 5

(c) Conversion operation (Recipe data save destination: SRAM user area)
Input the recipe number of the import or export source file into the Recipe No. Storage device.
Then, satisfy the condition of the conversion trigger.
The recipe data will be imported from a recipe file into the SRAM user area, or exported from the SRAM user area into a 
recipe file.
After an export operation, the source data will remain in the SRAM user area.
Use the following trigger devices.

*.G2P

Turn on the Convert Recipe File signal (D1000.b8).

*.TXT
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• To export the recipe data from the SRAM user area into a recipe file
Turn on the Convert Recipe File signal (bit 8 of the external control device).

• To import the recipe data from a recipe file into the SRAM user area
Turn on the Reverse-convert Recipe File signal (bit 9 of the external control device).

Example) Exporting the data of recipe No. 5 from the SRAM user area to a Unicode text file (*.TXT)
• [External Control Device]: D1000
• [Recipe No. Storage Device]: D1001 = 5

(2) Converting a recipe file in the recipe operation window

Convert a recipe file in the recipe operation window on the GOT.
Convert files one by one.
In this window, the conversion operation cannot be performed to the recipe data stored in the SRAM user area.

(a) Setting in GT Designer3
Step 1 Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the [Recipe Common 

Setting] dialog.

➟9.3.5 [Recipe Common Setting] dialog

Step 2 Select [Enable recipe file operation on the monitor], and click the [OK] button.
Step 3 To display the recipe operation window on the monitor screen, use a special function switch ([Switch Action]: 

[Recipe Information]).
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog

(b) Conversion operation
Perform one of the following operations to display the recipe operation window.

• Touch a special function switch ([Switch Action]: [Recipe Information]).
• Touch the [Oper.] button on the [Recipe information] screen in the utility.

For the recipe operation window and the operations in the utility, refer to the following.
➟GOT2000 Series User's Manual (Utility)

(3) Converting a recipe file in the utility
Convert a recipe file on the [Recipe information] screen on the GOT.
Convert files one by one.
In this window, the conversion operation cannot be performed to the recipe data stored in the SRAM user area.

➟GOT2000 Series User's Manual (Utility)

SRAM user area

Turn on the Convert Recipe File signal (D1000.b8).

Recipe data

Drive A 

*.TXT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Converting a recipe file with GT Designer3

Convert a recipe file on a personal computer.
Multiple files can be converted at a time.
Since the file is converted with GT Designer3, no processing load is put on the GOT.

Step 1 Transfer a recipe file to a personal computer from the GOT with one of the following methods.
• Transfer a recipe file with a data storage.
• Transfer a recipe file by connecting the personal computer with the GOT.
➟4.3 Transferring the Data between the Personal Computer and the GOT

Step 2 Click [Tools] → [Resource Data Conversion] → [Recipe File] from the menu to display the [Recipe File 
Conversion] dialog.

➟9.3.8 [Recipe File Conversion] dialog

Step 3 Set the following items, and click the [Convert] button. The converted recipe file is stored in the destination 
set in [Path] of [Destination File].
The conversion source file remains intact.
• [Type] in [Source of Conversion]

Select the file format of the conversion source file.
• [Path] in [Source of Conversion]

Set the storage location of the conversion source file.
• [Type] in [Destination File]

Select the file format of the conversion destination file.
• [Path] in [Destination File]

Set the storage location of the conversion destination file.

■5 Operations with the recipe display (record list)

The recipe display (record list) object lists the records of a recipe on the GOT.
The following operations are available on the object by using applicable key code switches.

For operating the recipe display (record list), refer to the following.
➟8.14 Placing a Recipe Display (Record List)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operation Description

Change record name Rename a record.

Read record Read a record from the PLC.

Write record Write a record to the PLC.

Verify record Verify the device values of a record against those of the PLC.

Delete record Delete a record.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■6 Operations in the recipe operation window and utility

The recipe operation window is not available on GT21 and GS21.
The following operations are available in the recipe operation window in the utility.

*1 The recipe data stored in the SRAM user area cannot be manipulated.
For the recipe operation window and the operations in the utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)

■7 Using a GOT1000 advanced recipe file (*.G1P)

You can use a GOT1000 advanced recipe file (*.G1P) to create a GOT2000 recipe file (*.G2P).

(1) Setting in GT Designer3
Set the following with GT Designer3 (GOT2000) according to the advanced recipe file (*.G1P) used.

Step 1 Select [Common] → [Recipe] → [Recipe] from the menu to display the [Recipe List] dialog.

➟9.3.6 [Recipe List] dialog

Step 2 Perform one of the following operations to display the [Recipe] dialog.
• Click the [New] button.
• Select a recipe setting and click the [Edit] button.
➟9.3.7 [Recipe] dialog

Operation Description

Recipe operations *1

Write
Writes the values of a specified record to the devices of a controller.

➟9.3.3 ■1 (3) Writing device values in the recipe operation window

Read
Reads device values from a controller, and overwrites the values of a specified record in a recipe 
file with the read values.

➟9.3.3 ■2 (3) Reading device values in the recipe operation window

Verify Verifies that the values of a record in a recipe file match the device values of a controller. 
Used to check if the read values are applied to the recipe file.

Save as Reads device values from a controller, and creates a recipe file to save the read values.

Copy Copies a recipe file.

New folder Creates a folder.

New recipe Creates a recipe file.

Convert
Converts the file format of a recipe file.

➟9.3.3 ■4 (2) Converting a recipe file in the recipe operation window

Rename Renames a recipe file.

Delete Deletes a recipe file.

Move Moves a recipe file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Step 3 Set the following items in the [Basic] tab.
• [Recipe Data Save Location]

Select [Data Storage (Recipe File)(read and write)].
• [File Name]

Enter the same file name as the advanced recipe file (*.G1P) used.
Step 4 Set the following items in the [Device] tab according to the advanced recipe file (*.G1P) used, and click the 

[OK] button.
• [Block Number]
• [Record Number]
• [Device Type] of each block
• [Points] of each block

(2) Preparation on a personal computer
Store the advanced recipe file (*.G1P) in the location, which is set in [Folder Name] in the [Basic] tab of the [Recipe] 
dialog.
Do not store a recipe file (*.G2P) in the same location.
If a recipe file (*.G2P) has already exist, another recipe file (*.G2P) is not created.

(3) Procedure on the GOT
To use an advanced recipe file (*.G1P) to create a GOT2000 recipe file (*.G2P), write or read device values by using a 
trigger device per project or per recipe setting.
The advanced recipe file (*.G1P) remains intact.
The following settings of the advanced recipe file (*.G1P) are applied to the created recipe file (*.G2P).
• Number of blocks
• Number of records
• Device type
• Points
• Device comment
• Record name
• Record update time (to which the GOT2000 time zone is applied, by using the source time zone as GMT 00:00)
• Record attribute
• Device values of records

(4) Precautions for using an advanced recipe file (*.G1P)
(a) When the settings of an advanced recipe file (*.G1P) are not applied

In the following cases, a recipe file (*.G2P) is created by using a recipe setting of GT Designer3 (GOT2000) instead of an 
advanced recipe file (*.G1P).

• The advanced recipe file (*.G1P) to be used is not stored in the location, which is set in [Folder Name] in the [Basic] 
tab of the [Recipe] dialog.
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• The recipe settings in GT Designer3 (GOT2000) are inconsistent with those of the advanced recipe file (*.G1P) to be 
used.

• The advanced recipe file to be used is damaged.

(b) Applying the recipe file (*.G2P) created based on an advanced recipe file (*.G1P)
The recipe file (*.G2P) cannot be used as a GOT1000 advanced recipe file (*.G1P).

(c) Saving an advanced recipe file (*.G1P) into the SRAM user area
You cannot save an advanced recipe file (*.G1P) directly into the SRAM user area.
Create a recipe file (*.G2P) based on an advanced recipe file (*.G1P), and then import data from the created file to the 
SRAM user area.
For information on how to import data from a recipe file (*.G2P) to the SRAM user area, refer to the following.

➟9.3.3 ■4 Converting a recipe file

■8 Operations with GOT special registers (GS) (Recipe special control)

With the specific GOT special registers (GS), you can read a record from recipe data into GOT data registers (GD) or 
overwrite the values of a record with those of GDs.
This recipe special control also enables you to check or edit the recipe data.

The following lists the actions of the recipe special control.

Action Description Reference

Resetting notification devices Reset the Recipe Special Control Result device (GS1011) and the 
Recipe Special Control No. device (GS1012) to 0. ➟(2) Resetting notification devices

Reading

Reading a record (in 
whole)

Read a record from the recipe data by specifying a record number.
The read record will be stored into the specified GOT data registers 
(GD).

➟(3) Reading a record (in whole)

Reading a record (in 
part)

Read part of the data in a record from the recipe data by specifying a 
record number and row.
The read record will be stored into the specified GOT data registers 
(GD).

➟(4) Reading a record (in part)

Reading device 
comments

This action is available when the save destination of the recipe data is 
set to the data storage (recipe file).
Read the device comments from the recipe data.
The read device comments will be stored into the specified GOT data 
registers (GD).

➟(5) Reading device comments

Writing

Writing a record (in 
whole)

Overwrite a record in the recipe data with the values of GOT data 
registers (GD) by specifying a record number. ➟(6) Writing a record (in whole)

Writing a record (in 
part)

Overwrite a record in the recipe data with the values of GOT data 
registers (GD) by specifying a record number and target rows. ➟(7) Writing a record (in part)

Writing device 
comments

This action is available when the save destination of the recipe data is 
set to the data storage (recipe file).
Overwrite the device comments in the recipe data with the values of 
GOT data registers (GD).

➟(8) Writing device comments

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Recipe data

Read or write

Target devices

GOT data register
(GD)

Recipe special control 
with GOT special registers (GS)

Write, 
read, 
or search

Reading or writing data with the recipe function
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(1) Recipe data targeted for the recipe special control
The recipe special control is usable only for the recipe data saved in a data storage or the SRAM user area.
To use the recipe special control, set [Recipe Data Save Location] to [Data Storage (Recipe File)(read and 
write)] or [Embedded Memory in GOT (read and write)] in the [Recipe] dialog ([Basic] tab).

(2) Execution timing of the recipe special control
Execute the recipe special control when no recipe process is performed by the recipe function.

(3) Precautions when using a text display or text input object
In the recipe special control, a recipe name, record name, or device comment is stored in Unicode, starting 
from the least significant bit.
When a device storing the above data is used in a text display or text input object, configure the following 
settings in the setting dialog of the object.

• Select [Unicode] for [Character Code] in the [Device/Style] tab.
• Select [Display in order of High -> Low] in the [Extended] tab.

(1) GOT special registers (GS) used for the recipe special control
You can use the Recipe Special Control Action device (GS1801) to specify the control action, and turn on the Execute 
Special Control signal (GS1800.b2) to execute the control.
For some actions, you must preset values in GS1802 to GS1808 and the GOT data registers (GD).
The following lists the GOT special registers (GS) used for the recipe special control.

• Read device list

Outputting recipe information
Output the following recipe information of a specified recipe setting: 
recipe No., recipe file format, recipe name, numbers of records, blocks, 
and rows, and total number of devices.

➟(9) Outputting recipe information

Searching
Performing a search 
by record name

Search recipe data for a record by record name.
The record number of the matching record is stored in the Recipe 
Special Control No. device (GS1012).

➟(10) Performing a search by record 
name

Action Description Reference

Device Name Function

GS1800

b0 to b1 Use prohibited -

b2 Execute Special Control Trigger 
signal

When this signal is turned on, the recipe special control is executed.
Set the control details with GS1801 to GS1808.
Execute the recipe special control when no recipe process is performed by the recipe 
function.

b3 to b13 Use prohibited -

b14 Clear Touch Switch Operation 
Status Information signal Not used

b15 Use prohibited -

GS1801 Recipe Special Control Action

Specify the control action. The action varies with the stored value.
• 0: Resets the Recipe Special Control Result device (GS1011) and the Recipe 

Special Control No. device (GS1012) to 0.
• 1: Reads a record from the target recipe data into GOT data registers (GD).
• 2: Overwrites the values of a record in the target recipe data with the values of GOT 

data registers (GD).
• 4: Outputs recipe information to GOT data registers (GD).
• 5: Searches the target recipe data based on the values of GOT data registers (GD).

GS1802

b0 Control Record Information signal When this signal is turned on, record information (record No., record attribute, and 
record name) is set as the control target.

b1 Control Date of Update signal When this signal is turned on, the update date and time of a record is set as the control 
target.

b2 Control Record Data signal When this signal is turned on, the device values of a record are set as the control 
target.

b3 Control Device Comment signal When this signal is turned on, device comments are set as the control target.

b4 to b15 Use prohibited -

GS1803 Recipe Special Control Start GD 
Device No.

Specify the start device number of the GOT internal devices (GD) to be used.
The data type must be unsigned 16-bit binary.

GS1805 Recipe Special Control Recipe 
No. Specify the recipe number of a target recipe setting.
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])

9 - 227



• Write device list

To notify the completion of the recipe special control, check that the Special Control Processing signal (GS1010.b2) is 
on, and then turn off the Execute Special Control signal (GS1800.b2) to turn off GS1010.b2.

Step 1 Preset values in GS1801 to GS1808 and the GOT data registers (GD) as necessary.
Step 2 Turn on the Execute Special Control signal (GS1800.b2).
Step 3 The recipe special control starts, and the Special Control Processing signal (GS1010.b2) turns on.

The Recipe Special Control Result device (GS1011) and the Recipe Special Control No. device (GS1012) 
are reset to 0.

Step 4 Check that GS1010.b2 is on, and then turn off GS1800.b2 by using trigger actions or other methods.
Step 5 Upon completion of the recipe special control, GS1010.b2 turns off.

GS1011 stores the result of the control.

GS1806 Recipe Special Control Record 
No. Specify the record number of a target record.

GS1807 Recipe Special Control Row No.

Specify the start row of a record as necessary.
Subtract 1 from a target row number, and then set the result as the value of GS1807.
Example 1) To specify row No. 1, set GS1807 to 0.
Example 2) To specify row No. 65536, set GS1807 to 65535.

GS1808 Recipe Special Control Points
Specify the number of target rows of a record as necessary.
Starting from the row specified with GS1807, the specified number of rows are 
targeted for the recipe special control.

Device Name Function

GS1010

b0 Import-in-progress signal Not used

b1 Export-in-progress signal Not used

b2 Special Control Processing signal
Turns on when the recipe special control is executed.
Turns off after the control is complete and the Execute Special Control signal 
(GS1800.b2) is turned off.

b3 to b13 Use prohibited -

b14 Touch Switch Operation 
Completed signal Not used

b15 Touch Switch Operation Error 
signal Not used

GS1011 Recipe Special Control Result

Stores the result of the recipe special control.
• 0: Normal completion
• Value other than 0: Error
For the details of errors, refer to the following.

➟(12) Error code list
This device is reset to 0 upon turn-on of the Execute Special Control signal 
(GS1800.b2).

GS1012 Recipe Special Control No.
Stores a record number as the search result.
This device is reset to 0 upon turn-on of the Execute Special Control signal 
(GS1800.b2).

Device Name Function

GS1801 to GS1808
GOT data registers (GD)

Execute Special Control signal
(GS1800.b2)

ON

OFF

Process of the recipe special control

Special Control Processing signal
(GS1010.b2)

ON

OFF

Recipe Special Control Result
(GS1011)

Recipe Special Control No.
(GS1012)

0 ResultPrevious result

Control details (such as the specified action)

ON

ON

0 Result

Control details (such as the specified action)
1.

2.

3.

4.

5.
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If you execute the recipe special control to search for a record, GS1012 stores the search result.

(2) Resetting notification devices
You can reset the Recipe Special Control Result device (GS1011) and the Recipe Special Control No. device (GS1012) 
to 0.
Set the Recipe Special Control Action device (GS1801) to 0, and then turn on the Execute Special Control signal 
(GS1800.b2).

(3) Reading a record (in whole)
You can read record information, date of update, and all the device values of a target record.
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

When the save destination of the recipe data is set to the data storage (recipe file), the operation is as follows: if no recipe 
file exists in the data storage, a recipe file will be created automatically and the special recipe control will start.
If the recipe file format is set to [CSV] or [Unicode Text], the created file contains the specified record only.

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

Device Set value Function

GS1801 1 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 or 1

When this bit is turned on, record information (record No., record attribute, and record 
name) is set to be read. (The record attribute refers to the settings of [Not to set the device 
value] and [Not to overwrite the device value in a recipe file].) 
Set this bit as necessary.
You can set this bit together with GS1802.b1 and GS1802.b2.

b1 0 or 1
When this bit is turned on, the update date and time of a target record is set to be read.
Set this bit as necessary.
You can set this bit together with GS1802.b0 and GS1802.b2.

b2 0 or 1
When this bit is turned on, the device values of a target record are set to be read.
Set this bit as necessary.
You can set this bit together with GS1802.b0 and GS1802.b1.

b3 0 The device value must be set as shown on the left.

GS1803 0 to 65535

Specify the start device number of the GOT internal devices (GD) that store the read data.
Reserve the GOT internal devices (GD) according to the size of data to be read.
• Record information: 34 word devices required
• Date of update: 4 word devices required
• Device values of a record: The required number of word devices varies with the device 

types and number of devices that are targeted for the control.
For the specifications of storing data and each data size, refer to the following.

➟(a) Record information, date of update, and device values of a record

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 The device value must be set as shown on the left.

GS1808 0
The device value must be set as shown on the left.
When this device stores 0, all the device values of a target record are read to the GOT data 
registers (GD).
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(4) Reading a record (in part)
You can read record information, date of update, and the device values in the specified rows of a target record.
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

When the save destination of the recipe data is set to the data storage (recipe file), the operation is as follows: if no recipe 
file exists in the data storage, a recipe file will be created automatically and the special recipe control will start.
If the recipe file format is set to [CSV] or [Unicode Text], the created file contains the specified record only.

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

Device Set value Function

GS1801 1 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 or 1

When this bit is turned on, record information (record No., record attribute, and record 
name) is set to be read. (The record attribute refers to the settings of [Not to set the device 
value] and [Not to overwrite the device value in a recipe file].)
Set this bit as necessary.
You can set this bit together with GS1802.b1 and GS1802.b2.

b1 0 or 1
When this bit is turned on, the update date and time of a target record is set to be read.
Set this bit as necessary.
You can set this bit together with GS1802.b0 and GS1802.b2.

b2 1
The device value must be set as shown on the left.
When this bit is turned on, the device values of a target record are set to be read.
You can set this bit together with GS1802.b0 and GS1802.b1.

b3 0 The device value must be set as shown on the left.

GS1803 0 to 65535

Specify the start device number of the GOT internal devices (GD) that store the read data.
Reserve the GOT internal devices (GD) according to the size of data to be read.
• Record information: 34 word devices required
• Date of update: 4 word devices required
• Device values of a record: The required number of word devices varies with the device 

types and number of devices that are targeted for the control.
For the specifications of storing data and each data size, refer to the following.

➟(a) Record information, date of update, and device values of a record

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 to 65535
Specify the start row to be read.
Subtract 1 from a target row number, and then set the result as the value of GS1807.

GS1808 1 to 65535 Set the number of rows to be read.
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(5) Reading device comments
You can read device comments.
This operation is available when the save destination of the recipe data is set to the data storage (recipe file).
Note that device comments must be read independently of the other data (such as record information).

If the target recipe file is in the binary format (*.G2P), the device comments are read from the file.
If the target recipe file is in the CSV or Unicode text format (*.CSV or *.TXT), the device comments are read from the 
corresponding recipe setting in the project.

Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

If you execute the recipe special control for a recipe setting without the corresponding recipe file, a recipe file is created 
automatically and then the control starts. (Only when the recipe file format is set to [G2P (Binary)])

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

Device Set value Function

GS1801 1 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 The device value must be set as shown on the left.

b1 0 The device value must be set as shown on the left.

b2 0 The device value must be set as shown on the left.

b3 1
When this bit is turned on, device comments are set to be read.
You cannot set this bit together with GS1802.b0, GS1802.b1, and GS1802.b2.

GS1803 0 to 65535

Specify the start device number of the GOT internal devices (GD) that store the read data. 
Reserve the GOT internal devices (GD) according to the size of data to be read.
• Device comment: 32 word devices × Specified number of rows
For the specifications of storing data and each data size, refer to the following.

➟(b) Device comment

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 to 65535
Specify the start row to be read.
Subtract 1 from a target row number, and then set the result as the value of GS1807.

GS1808 1 to 65535 Set the number of rows to be read.
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(6) Writing a record (in whole)
You can overwrite record information (record name only) and all the device values of a target record.
Store the write source data in GOT data registers (GD).
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

When the save destination of the recipe data is set to the data storage (recipe file), the operation is as follows: if no recipe 
file exists in the data storage, a recipe file will be created automatically and the special recipe control will start.
If the recipe file format is set to [CSV] or [Unicode Text], the created file contains the specified record only.

The date and time at which the device values of a record are overwritten is stored as the update date and time of the 
record.
If [Not to overwrite the device value in a recipe file] is selected in the record attribute setting, overwriting the device values 
results in an error. (If both record information and device values are set to be overwritten, record information is also not 
overwritten.)

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

Device Set value Function

GS1801 2 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 or 1
When this bit is turned on, record information (record name only) is set to be overwritten.
Set this bit as necessary.
You can set this bit together with GS1802.b1 and GS1802.b2.

b1 0 or 1 This bit is disabled because the date of update cannot be overwritten.

b2 0 or 1
When this bit is turned on, the device values of a target record are set to be overwritten.
Set this bit as necessary.
You can set this bit together with GS1802.b0 and GS1802.b1.

b3 0 The device value must be set as shown on the left.

GS1803 0 to 65535

Specify the start device number of the GOT data registers (GD) that store the write source 
data.
Store the write source data in the GOT data registers (GD) according to the specifications 
of storing data.
• Record information: 34 word devices required
• Date of update: 4 word devices required
• Device values of a record: The required number of word devices varies with the device 

types and number of devices that are targeted for the control.
For the specifications of storing data and each data size, refer to the following.

➟(a) Record information, date of update, and device values of a record

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 The device value must be set as shown on the left.

GS1808 0
The device value must be set as shown on the left.
When this device stores 0, all the device values of a target record are overwritten.
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(7) Writing a record (in part)
You can overwrite record information (record name only) and the device values in the specified rows of a target record.
Store the write source data in GOT data registers (GD).
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

When the save destination of the recipe data is set to the data storage (recipe file), the operation is as follows: if no recipe 
file exists in the data storage, a recipe file will be created automatically and the special recipe control will start.
If the recipe file format is set to [CSV] or [Unicode Text], the created file contains the specified record only.

The date and time at which the device values of a record are overwritten is stored as the update date and time of the 
record.
If [Not to set the device value] is selected in the record attribute setting, the device values in the unspecified rows are 
overwritten with 0.
If [Not to overwrite the device value in a recipe file] is selected in the record attribute setting, overwriting the device values 
results in an error. (If both record information and device values are set to be overwritten, record information is also not 
overwritten.)

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

(8) Writing device comments
You can overwrite device comments.
This operation is available when the save destination of the recipe data is set to the data storage (recipe file).
Note that device comments must be overwritten independently of the other data (such as record information).
To overwrite device comments, satisfy all the following conditions.

• A binary recipe file (*.G2P) is used.
• [Include device comments in conversion target] is selected when a recipe file in the CSV or Unicode text format is 

Device Set value Function

GS1801 2 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 or 1
When this bit is turned on, record information (record name only) is set to be overwritten.
Set this bit as necessary.
You can set this bit together with GS1802.b1 and GS1802.b2.

b1 0 or 1 This bit is disabled because the date of update cannot be overwritten.

b2 1
The device value must be set as shown on the left.
When this bit is turned on, the device values of a target record are set to be overwritten.
You can set this bit together with GS1802.b0 and GS1802.b1.

b3 0 The device value must be set as shown on the left.

GS1803 0 to 65535

Specify the start device number of the GOT data registers (GD) that store the write source 
data.
Store the write source data in the GOT data registers (GD) according to the specifications 
of storing data.
• Record information: 34 word devices required
• Date of update: 4 word devices required
• Device values of a record: The required number of word devices varies with the device 

types and number of devices that are targeted for the control.
For the specifications of storing data and each data size, refer to the following.

➟(a) Record information, date of update, and device values of a record

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 to 65535
Specify the start row to be written.
Subtract 1 from a target row number, and then set the result as the value of GS1807.

GS1808 1 to 65535 Set the number of rows to be written.
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converted back to the binary format.

Store the write source data in GOT data registers (GD).
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

If you execute the recipe special control for a recipe setting without the corresponding recipe file, a recipe file is created 
automatically and then the control starts. (Only when the recipe file format is set to [G2P (Binary)])

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

(9) Outputting recipe information
You can output information on the specified recipe setting.
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

After the control is complete, the Recipe Special Control Result device (GS1011) stores 0.
If an error occurs, GS1011 stores a value other than 0.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list

Device Set value Function

GS1801 2 The device value must be set as shown on the left to specify this action.

GS1802

b0 0 The device value must be set as shown on the left.

b1 0 The device value must be set as shown on the left.

b2 0 The device value must be set as shown on the left.

b3 1
When this bit is turned on, device comments are set to be overwritten.
You cannot set this bit together with GS1802.b0, GS1802.b1, and GS1802.b2.

GS1803 0 to 65535

Specify the start device number of the GOT data registers (GD) that store the write source 
data.
Store the write source data in the GOT data registers (GD) according to the specifications 
of storing data.
• Device comment: 32 word devices × Specified number of rows
For the specifications of storing data and each data size, refer to the following.

➟(b) Device comment

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 1 to 2000 Specify the record number of a target record.

GS1807 0 to 65535
Specify the start row to be written.
Subtract 1 from a target row number, and then set the result as the value of GS1807.

GS1808 1 to 65535 Set the number of rows to be written.

Device Set value Function

GS1801 4 The device value must be set as shown on the left to specify this action.

GS1803 0 to 65535

Specify the start device number of the GOT internal devices (GD) that store the read data.
Reserve the GOT internal devices (GD) according to the size of data to be read.
• Record information: 40 word devices required
For the specifications of storing data and each data size, refer to the following.

➟(c) Recipe information

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 0 The device value must be set as shown on the left.

GS1807 0 The device value must be set as shown on the left.

GS1808 0 The device value must be set as shown on the left.
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(10)Performing a search by record name
You can search for a record that has the specified record name.
When the target recipe files are in the CSV or Unicode text format (*.CSV or *.TXT), each file contains one record only. 
Each time the recipe file corresponding to a record is not found, the specified recipe setting in the project data is searched.
Set GS1801 to GS1808 as shown below, and then turn on the Execute Special Control signal (GS1800.b2).

When the save destination of the recipe data is set to the data storage (recipe file), the operation is as follows: if no recipe 
file exists in the data storage, a recipe file will be created automatically and the special recipe control will start.
(Only when the recipe file format is set to [G2P (Binary)])

Upon completion of the control, the Recipe Special Control Result device (GS1011) and the Recipe Special Control No. 
device (GS1012) store a value according to the search result.

• If the matching record is found, GS1011 stores 1, and GS1012 stores the record number.
• If no matching record is found, GS1011 and GS1012 each store 0.

If an error occurs, GS1011 stores a value other than 0 and 1.
For the error codes and corrective actions, refer to the following.

➟(12) Error code list
If a recipe file in the CSV or Unicode text format (*.CSV or *.TXT) causes an error during a search, the Recipe Special 
Control No. device (GS1012) stores the record number of the recipe file.
If the error has been caused by any other reason, GS1012 stores 0.

Device Set value Function

GS1801 5 The device value must be set as shown on the left to specify this action.

GS1802

b0 1 When this bit is turned on, a record having the specified record name is searched for.

b1 0 The device value must be set as shown on the left.

b2 0 The device value must be set as shown on the left.

b3 0 The device value must be set as shown on the left.

GS1803 0 to 65535

Specify the start device number of the GOT data registers (GD) that store the record name 
for search.
Store the name in the GOT data registers (GD) according to the specifications of storing 
data.
• Record name for search: 32 word devices required
For the specifications of storing data and each data size, refer to the following.

➟(d) Record name for search

GS1805 1 to 32767 Specify the recipe number of a target recipe setting.

GS1806 0 to 2000
Specify the record number of a record from which a search starts.
The search is performed in ascending order of the record numbers.
When this device stores 0, the search starts from record No.1.

GS1807 0 The device value must be set as shown on the left.

GS1808 0 The device value must be set as shown on the left.
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(11)Specifications of storing data in GOT data registers (GD)
When you execute the recipe special control to read data, the GOT data registers (GD) store the read data as shown 
below.
Store the write source data to the GOT data registers (GD) in the same manner.

(a) Record information, date of update, and device values of a record
• Record information

To store record information, reserve 34 word devices.
Example) Start device: GD1000

• Date of update
To store the date of update, reserve four word devices.
Example) Start device: GD1000

Order Stored data Details

Start device Record No. This device is disabled and skipped at the time of writing data.

2nd device Record attribute

• b0: With or without initial device values (0: With, 1:Without)
• b1: Writable or write-protect (0: Writable, 1: Write-protect)
• b2 to b15: Use prohibited
This device is disabled and skipped at the time of writing data.

3rd device to the 33rd 
device Record name

The data is stored in Unicode.
If a record name has less than 32 characters, the name is stored with a 
termination character (0) appended.
If a record name has 32 characters, the name is stored with no termination 
character appended.

Order Stored data Details

Start device Month and year
• b8 to b15: Year (Data type: BCD)
• b0 to b7: Month (Data type: BCD)
This device is disabled and skipped at the time of writing data.

2nd device Date and hour
• b8 to b15: Date (Data type: BCD)
• b0 to b7: Hour (Data type: BCD)
This device is disabled and skipped at the time of writing data.

3rd device Minute and second
• b8 to b15: Minute (Data type: BCD)
• b0 to b7: Second (Data type: BCD)
This device is disabled and skipped at the time of writing data.

4th device Day of the week

• b8 to b15: Use prohibited
• b0 to b7: Day of the week (0: Sunday, 1: Monday, 2: Tuesday, 3: Wednesday, 

4: Thursday, 5: Friday, 6: Saturday)
This device is disabled and skipped at the time of writing data.

GD1000

GD1001

GD1002

Record No.

Record attribute

Record name

GD1033

34 word devices

GD1000

GD1001

GD1002

Month and year

Date and hour

Day of the weekGD1003

4 word devices
Minute and second
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• Device values of a record
For storing the device values of a record, the required number of word devices varies with the device types and 
number of devices in the record.
The device values of a record are stored in the order specified in the recipe setting.
Example)
Start device: GD1000
Target devices of a record: Bit (1 device), Signed BIN16 (2 devices), BCD32 (1 device), and String (5 devices)

Device type Required number of word devices Details

Bit 1 Only the value of bit 0 is applied.

Signed BIN8 1 -

Unsigned BIN8 1 -

Signed BIN16 1 -

Unsigned BIN16 1 -

Signed BIN32 2 -

Unsigned BIN32 2 -

Signed BIN64 4 -

Unsigned BIN64 4 -

BCD16 1 -

BCD32 2 -

BCD64 4 -

Real(32bit) 2 -

Real(64bit) 4 -

String Specified number of devices
The specified number of word devices are used.
Data is stored in the specified character code.

GD1005

GD1006

GD1007 String (5 devices)

GD1008

GD1000

GD1001

GD1002

Bit (1 device)

Signed BIN16 (2 devices)

BDC32 (1 device)
GD1004

10 word devices

GD1003

GD1009
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• Reading record information, date of update, and devices values of a target record simultaneously
The record information, date of update, and device values are stored in that order.
Example)
Start device: GD1000
Data of a record to be read: record information, date of update, and device values

(b) Device comment
To store one device comment, reserve 32 word devices. For two or more device comments, multiply 32 word devices by 
the specified number of rows.
Example)
Start device: GD1000
Specified number of rows: 5

The data is stored in Unicode.

Order Stored data Details

Start device to the 32nd 
device Device comment Storing one device comment requires 32 word devices.

GD1034

GD1035

GD1036

Month and year

Date and hour

Day of the weekGD1037

4 word devices
Minute and second

GD1000

GD1001

GD1002

Record No.

Record attribute

Record name

GD1033

34 word devices

GD1043

GD1044

GD1045 String (5 devices)

GD1046

GD1038

GD1039

GD1040

Bit (1 device)

Signed BIN16 (2 devices)

BDC32 (1 device)
GD1042

10 word devices

GD1041

GD1047

Record information

Date of update

Device values 
of a record

GD1128

GD1159

Device comment (5th row)

GD1000

GD1031

Device comment (1st row)

160 word devices
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(c) Recipe information
To store recipe information, reserve 40 word devices.
Example) Start device: GD1000

(d) Record name for search
To store a record name for search, reserve 32 word devices.
Example) Start device: GD1000

Order Stored data Details

Start device Recipe No. -

2nd device File format

Recipe file format
• 0: Does not use a recipe file.
• 1: Binary format (*.G2P)
• 2: CSV format (*.CSV)
• 3: Unicode text format (*.TXT)

3rd device to the 34th 
device Recipe name

The data is stored in Unicode.
If a record name has less than 32 characters, the name is stored with a 
termination character (0) appended.
If a record name has 32 characters, the name is stored with no termination 
character appended.

35th device Number of records -

36th device Number of blocks -

37th and 38th devices Number of rows Number of rows of the recipe setting

39th and 40th devices Total number of devices Total number of devices of the recipe setting

Order Stored data Details

Start device to the 32nd 
device Record name for search

The data is stored in Unicode.
The stored record name (including the termination character (0)) is used as the 
search criterion.

GD1000

GD1001

GD1002

Recipe No.

File format

Recipe name

GD1033

40 word devicesGD1034

GD1035

Number of records

Number of blocks

GD1036

GD1037

GD1038

GD1039

Number of rows

Total number 
of devices

GD1000
Record name 
for search

GD1031

32 word devices
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(12)Error code list
The following lists the error codes that are stored in the Recipe Special Control Result device (GS1011) and the corrective 
actions.

Error code Cause and corrective action

-1
Any of the set values in GS1801 to GS1808 is incorrect.
Correct the set values.

322
The specified device number is outside the device range for GOT data registers (GD).
Specify a device number within the device range.

345
A binary-to-BCD conversion error occurred.
Make sure that the data types of the target device values are the same as the device types set in the recipe setting.

575
Device comments cannot be overwritten because the recipe file is not in the binary format (*.G2P) or [Include device 
comments in conversion target] is not selected in the [Recipe] dialog ([Basic] tab).
Select [Include device comments in conversion target] in the recipe setting in the project.

576
The specified row number is nonexistent.
Specify an existent row number.

581
An invalid recipe file exists.
Delete the invalid recipe file.

582

Creating a recipe file has failed.
Check that the following conditions are satisfied, and then execute the recipe special control again.
• A data storage is installed on the GOT.
• The SD card cover is closed.
• The SD card access switch is turned on.
• The installed data storage has enough free space.

583

Writing data to the target recipe file has failed.
Check that the following conditions are satisfied, and then execute the recipe special control again.
• The data storage is not write-protected.
• The recipe file is not write-protected.

584
Writing data to the target recipe file has failed.
Do not remove the data storage during the recipe special control.
For saving data to the SRAM user area, consult your local sales office.

585
Reading data from the target recipe file has failed.
Do not remove the data storage during the recipe special control.
For saving data to the SRAM user area, consult your local sales office.

586
The specified recipe number is nonexistent.
Specify an existent recipe number.

587
The specified record number is nonexistent.
Specify an existent record number.

588
The target record cannot be overwritten because the record is write-protected.
Disable the write protection for the target record in the recipe setting in the project, or specify another writable record.

589
The recipe special control cannot be executed because the target recipe setting is set not to use a recipe file.
Execute the recipe special control for a recipe setting that is set to use a recipe file.

591
The contents of the target recipe file do not match the source recipe setting.
Correct the recipe setting in the project, and then write the data to the GOT again.
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■9 Link with the recipe display (record list) by using GOT special registers

The following GOT special registers store information of the recipe display (record list).
• GS1013: Stores the recipe number for the records displayed on the recipe display (record list).
• GS1014: Stores the record number selected on the recipe display (record list).

With GS1013 and GS1014, you can specify a recipe number and a record number on the recipe display (record list), and 
perform operations such as the following.

• Write the values of GS1013 and GS1014 to the PLC CPU devices (Recipe No. Storage device and Record No. 
Storage device specified in the recipe common setting), and run a sequence program to turn on the trigger device of 
the target recipe process.

• Write the values of GS1013 and GS1014 to the GOT special registers (GS1805 and GS1806), and turn on the trigger 
device of the recipe special control.

For the recipe common setting, refer to the following.
➟9.3.5 [Recipe Common Setting] dialog

For the recipe special control, refer to the following.
➟9.3.3 ■8 Operations with GOT special registers (GS) (Recipe special control)

(1) Application example
Example) Checking the device values of a record selected on the recipe display (record list) and writing the values to 
target devices
Execute the recipe special control to read the device values of the record selected on the recipe display (record list), and 
display the read values on numerical display objects.
Check the values on numerical display objects, and write the values to target devices.

Configure the following settings on GT Designer3.

Perform the following operations on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Object Description

Switch

Inputs data to the GOT special registers (GS1801 to GS1803, GS1807, and GS1808), and executes the 
recipe special control.
Set the following actions to run in top-to-bottom order as shown below.
• [Word Set]: Write 1 to GS1801.
• [Word Set]: Write the start device number of GOT data registers (GD) to GS1803. (The start device number 

is user-configurable, and the GD devices store the device values of a record.)
• [Word Set]: Write the value of GS1013 to GS1805.
• [Word Set]: Write the value of GS1014 to GS1806.
• [Word Set]: Write 0 to GS1807.
• [Word Set]: Write 0 to GS1808.
• [Bit Set]: Turn on GS1802.b2.
• [Bit Reset]: Turn off GS1802.b0.
• [Bit Reset]: Turn off GS1802.b1.
• [Bit Reset]: Turn off GS1802.b3.
• [Bit Momentary]: Turn on GS1800.b2 while the switch is being touched.

Key Code Switch

Writes the device values of a record to target devices.
Use the applicable key code switch that is placed automatically upon placement of the recipe display (record 
list).
When placing the applicable key code switch manually, configure the following settings.
• Select [Recipe Display (Record List)] for [Key Code Type].
• Select [Load record] for [Action].

Numerical Display
Displays a device value of the record that has been read by the recipe special control.
Place numerical displays corresponding to the number of target devices.
Set the numerical displays according to the types of devices in the record.

Recipe Display (Record List)
On this object, select a recipe number and a record number that are targeted for the recipe special control.
In [Recipe No.], specify a target recipe number.
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Step 1 On the recipe display (record list), select a record to write its device values to target devices.
Step 2 Touch the switch dedicated to the recipe special control to display the device values of the selected record 

on the numerical displays.
Step 3 Check the displayed values, and touch the applicable key code switch to write the values to target devices.

■10 Saving recipe data into the SRAM user area

You can save recipe data into the SRAM user area.
Values are readable from the target devices of a controller into the SRAM user area instead of a data storage.
The SRAM user area space is limited and used for the other functions as well.
Before saving the recipe data, make sure that the SRAM user area has enough free space.

(1) Specifications of the SRAM user area
For the specifications of the SRAM user area, refer to the following.

➟12.12 Specifications of the SRAM user area

(2) Deleting and backing up the data in the SRAM user area
The data saved in the SRAM user area is deleted under the following conditions.

• Project data and system applications are written to the GOT when [Initialize SRAM user area when writing project 
data/OS] is selected in the [Communicate with GOT] dialog.

• The SRAM user area is initialized by using [SRAM management] in the utility.
• The clear trigger device set in [Buffering] of the user alarm observation setting or the system alarm observation 

setting turns on.
• The SRAM user area is set to be initialized when GT SoftGOT2000 starts the first monitoring.

To retain the data saved in the SRAM user area, execute the backup/restoration function in the utility.
For the details of the backup/restoration function, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(3) Precautions for using the SRAM user area
Data may not be saved into the SRAM user area due to some reasons, including the setting change of an applicable 
function and physical memory corruption.

(a) Normal conditions
The data collected by each applicable function is saved to the SRAM user area.

No.
1
2
3

Product
Product 1
Product 2
Product 3

4
5

Product 4
Product 5

Raw material
Raw material 1
Raw material 2
Raw material 3

Value
100
50

10000
Raw material 4
Processing time

0.5
120

Select a record on the recipe display (record list).

Touch the switch dedicated to the recipe special control.

Check the device values of the record, 
and touch the key code switch to write the values.

1.

2.
3.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
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(b) Setting change
If the size of data to be collected by the user alarm observation, system alarm observation, or logging function is changed, 
the data of the function saved in the SRAM user area will be deleted.

• When the size is reduced:
The data is saved to the initialized area. The remaining area is reserved as a free area.

• When the size is increased:
The area used is initialized and the data is saved to another area.
If the area required for saving the data is insufficient, an error occurs.
If an error occurs, initialize the SRAM user area, reduce the data size to 500 KB or less, and save the data again.
Example) When the size for ID 1 is increased from 100 KB to 200 KB

(c) Setting deletion
When the setting of each function is deleted, the SRAM user area used for saving the data is reserved as an unused area.
Initialize the unused area to use it.
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)
Example) When the setting of ID 1 is deleted

(d) Others
If the data saved in the SRAM user area is not restored at the GOT startup, a system alarm occurs.
In such a case, check the battery status.

• When the battery status is normal:
A part of the SRAM user area may be damaged.
Initialize the SRAM user area.

➟GOT2000 Series User's Manual (Utility)
• When the voltage is low:

Replace the battery.
If the data is still not restored after the battery is replaced, initialize the SRAM user area.
For information on how to replace the battery, refer to the following.

➟GOT2000 Series User's Manual (Hardware)
For the initialization of the SRAM user area, refer to the following.

➟GOT2000 Series User's Manual (Utility)

ID2: 100KB
ID3: 200KB

Free area

Free areaID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area is initialized.
In this case, ID 1 cannot be saved to 
another area, and an error occurs.
The initialized area becomes a free area.

Reserved area
ID2: 100KB
ID3: 200KB

Free area

ID1: 100KB
ID2: 100KB
ID3: 200KB

Free area

500KB
The saving area for ID 1 becomes a 
reserved area.
By setting the setting of ID 1, the saved 
data can be retained for other use.
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])

9 - 243



9.3.4 Precautions

This section explains the precautions for using the recipe function.
➟■1 Precautions for drawing
■2 Precautions for editing recipe files
■3 Precautions for use
■4 Precautions for using the Character Code for CSV Conversion signal (GS522.b2)
■5 Precautions for using the SRAM user area

■1 Precautions for drawing
(1) Number of blocks and maximum number of target devices

To specify the number of target devices more than the number of blocks, set consecutive devices in blocks.
Depending on the number of blocks and the setting of [Points], specifying the number of target devices up to its upper 
limit may be unavailable.
Example) When 2048 is set in [Block Number] and 1 is set in [Points] of all the blocks
According to the upper limit of the number of blocks, up to 2048 devices can be set.

(2) Number of blocks and processing time
When a large number of blocks are set in a recipe setting, processing time for writing and reading may increase.
To shorten the processing time, reduce the number of blocks.

(3) Influence by recipe file size
A large recipe file requires more space in a data storage, takes a long writing or reading time, and influences others.
The following shows methods to reduce the size of a recipe file.
• Reduce the number of characters in device comments.
• Reduce the number of digits of the record initial values.
• Exclude device comments from the conversion target.

(4) Project size and recipe setting
The project size (ROM or RAM) must be equal to or smaller than the capacities of the GOT storage memory (ROM) and 
operation memory (RAM).
Depending on the recipe setting (including the number of records, number of target devices, and record initial values) and 
other function settings, setting items may not be set up to each upper limit due to the project size.

(5) Save destination of recipe files
Do not specify the same save destination on the GOT for recipe files and for files of other functions (such as the alarm 
function).
Only recipe files can be displayed or operated on the [Recipe information] screen in the utility.
When a recipe file and a file of other functions are stored in the same folder, the folder cannot be deleted on the [Recipe 
information] screen.

(6) Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(7) Reflecting the device values of a record to the project data
The project data holds the initial device values of records in a recipe setting.
Even if you change a device value of a record on the GOT, the change is not automatically reflected to the project data.
To reflect the change made on the GOT to the project data, use GT Designer3 to import the recipe file from the GOT to 
the project data.

➟4.3 ■3 Reading the data from the GOT
9.3 ■2 [Device] tab

(8) When setting a string-type label or tag for the recipe target device
Set [Device Type] to [String].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(9) Character code when a string-type label or tag is set for the device whose [Device Type] is set to 
[String]
If you set a string-type label or tag for the device whose [Device Type] is set to [String], set the character code according 
to the type of the label or tag.

• System label Ver.1: ASCII code or Shift JIS code
• System label Ver.2 and global label: ASCII code, Unicode, or Shift JIS code
• OMRON NJ/NX tag: Unicode
• AB native tag: ASCII code
• OPC UA tag: Unicode

■2 Precautions for editing recipe files
(1) Character code and conversion destination file

If a device comment or record name contains any character other than ASCII and Shift JIS characters, convert the 
relevant file as shown below.

• Convert the file to Unicode text format.
• Turn on the Character Code for CSV Conversion signal (GS522.b2), and convert the file to CSV format.

(2) Editing a recipe file having more than 251 records
If a recipe file in binary format (*.G2P) has more than 251 records, use a text editor or Microsoft Excel 2007 or later to 
open the file.

(3) Editing a device comment
Set a device comment within the maximum number of characters.
Characters exceeding the maximum number of characters cannot be applied to a reverse-converted recipe file.
Set the maximum number of characters used for a device comment in [Maximum number of characters] in the [Basic] tab 
of the [Recipe] dialog.

(4) Editing a CSV file or Unicode text file
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

■3 Precautions for use
(1) Priority when multiple trigger conditions are satisfied simultaneously

When trigger conditions for writing, reading, and file conversion are satisfied simultaneously, the processes are executed 
in the following order.

If a satisfied trigger condition becomes unsatisfied before the processing order comes, the process is not executed.
Example) When the trigger condition becomes unsatisfied before the writing process of recipe No. 3 is executed

Priority Trigger device

Trigger device per recipe setting

Recipe No. 1
Read trigger device

Write trigger device

: :

Recipe No. 32767
Read trigger device

Write trigger device

Trigger device per project

Read trigger device

Write trigger device

Trigger File Conversion device

High

Low
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To make sure that the processing for the simultaneously-satisfied triggers are executed, set the trigger devices for each 
recipe setting as follows.
Multiple recipes can be processed sequentially by turning on and off one device.
• Set the conditions to satisfy the trigger devices to "OFF". (A trigger condition is satisfied when a device turns off.)
• Set the same device as the trigger devices of multiple recipe settings.

➟9.3.7 ■1 [Basic] tab
Example) Executing the writing processes of recipe No. 1 to 3 sequentially
• [Write Trigger 1] of recipe No. 1 to 3: X1000
• Trigger condition of [Write Trigger 1] of recipe No. 1 to 3: [OFF]

(2) When a trigger condition is satisfied while the recipe operation window or the [Recipe information] 
screen is being displayed
The trigger devices for writing, reading, and file conversion are ignored while the recipe operation window or the [Recipe 
information] screen is being displayed.
You can check the display status of the recipe operation window or the [Recipe information] screen with Screen 
Displaying (Trigger Disabled) Notification signal (External notification device.b14).

➟9.3.5 ■2 [External Notification Device]

Write trigger of recipe No. 1 
(Trigger condition: ON)

OFF

OFF

OFF

OFF

ON

ON

ON

ON

Recipe-shared Write-in-progress signal
(External notification device.b0) Processing 

of the recipe 
No. 1

Processing 
of the recipe 
No. 2

The processing is not executed 
because the trigger condition 
becomes unsatisfied before its 
processing order comes.

Write trigger of recipe No. 2 
(Trigger condition: ON)

Write trigger of recipe No. 3 
(Trigger condition: ON)

X1000 
(Write trigger of recipe No. 1 to 3)

Recipe-shared Write-in-progress signal
(External notification device.b0)

ON

ON

OFF

OFF

Processing 
of the recipe 
No. 1

Processing 
of the recipe 
No. 2

Processing 
of the recipe 
No. 3

Processing 
of the recipe 
No. 1

Processing 
of the recipe 
No. 2

Processing 
of the recipe 
No. 3

Write trigger device per project

Write trigger device per recipe setting

Screen Displaying (Trigger Disabled) 
Notification signal
(External notification device.b14)

OFF

ON

ON

OFF

OFF

The trigger condition is ignored 
while Screen Displaying 

(Trigger Disabled) Notification 
signal is on
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(3) Trigger judgment when the same trigger condition is repeatedly satisfied
A trigger judgment is conducted each and every time a trigger condition is satisfied.
When the state of a trigger condition changes from satisfied to unsatisfied to satisfied, a trigger judgment is conducted 
again.
When the time while the trigger condition is not satisfied is too short, the trigger cannot be detected as its condition is not 
satisfied. Therefore, the recipe may not be processed.

(4) Timing to change the writing or reading target after a trigger condition is satisfied
Before changing the writing or reading target (such as the recipe number and the record number), confirm that the writing 
or reading process are complete with the following signals.
• For the writing process: Recipe-shared Write Completed signal (External notification device.b4)
• For the reading process: Recipe-shared Read Completed signal (External notification device.b5)
If you change the target before the corresponding signal turns on, a next writing or reading process may not be executed 
properly.

(5) When the writing or reading process cannot be executed
In the save destination, if a recipe file with the same name is already created for another recipe setting, writing or reading 
device values cannot be executed.
Remove the recipe file from the save destination, and then write or read device values.

(6) Changing the recipe setting after its recipe file is created
When a recipe file is used, device values are written to or read from the recipe file.
In the save destination, if another recipe file already exists, changes made in GT Designer3 are not applied to the recipe 
file and the writing or reading of device values.
Remove the recipe file from the save destination, and then write or read device values.

(7) Recipe file created when a recipe process error occurs
Even if a recipe process error occurs, a recipe file may still be created.
Change the setting in GT Designer3 to remove error causes, and then create a recipe file again.

(8) Changing the save destination or file name of a recipe file
If you directly change the save destination or name of a recipe file used, also change its save destination or name in the 
corresponding recipe setting.

(9) To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

Write trigger device

Recipe-shared Write-in-progress signal
(External notification device.b0) Processing of the recipe No. 1

The processing of 
the recipe No. 1 is 
not executed.

Since the off time of the write trigger is short, 
the trigger judgment is not conducted.

OFF

OFF

ON

ON ON
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■4 Precautions for using the Character Code for CSV Conversion signal (GS522.b2)
(1) When using a CSV file as a recipe file

When using a CSV file as a recipe file, observe the following rules.
• If a CSV file has been created while GS522.b2 is on, make sure that GS522.b2 is on when the file is used.
• If a CSV file has been created while GS522.b2 is off, make sure that GS522.b2 is off when the file is used.
Failure to observe the rules renders the relevant file unreadable.

(2) When converting a CSV file to binary format
When converting a CSV file to binary format, observe the following rules.
• If a binary file has been converted to a CSV file while GS522.b2 is on, make sure that GS522.b2 is on when the CSV 
file is converted to a binary file.

• If a binary file has been converted to a CSV file while GS522.b2 is off, make sure that GS522.b2 is off when the CSV 
file is converted to a binary file.

Failure to observe the rules cannot convert the relevant file.

■5 Precautions for using the SRAM user area
(1) Fields to be imported

If you import a recipe file into the SRAM user area by using a special function switch (Recipe data operation) or external 
control device, only the following fields are imported.
• Record name
• Record attribute
• Values of the record
To use device comments or other fields, save the recipe data to a recipe file in the data storage.

(2) Backing up the recipe data stored in the SRAM user area
If you delete the recipe data from the SRAM user area because the data is invalid (system alarm 581 or other errors), 
back up the data before deletion.
Back up the recipe data and the rest of the data in the SRAM user area by using [SRAM management] in the utility.

➟GOT2000 Series User's Manual (Utility)
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9.3.5 [Recipe Common Setting] dialog

Set devices for controlling the recipe function.
Select [Common] → [Recipe] → [Recipe Common Setting] from the menu to display the following dialog.

1) [External Control Information]
Enable the device setting to control the writing and reading processes. This setting is common to all the recipe settings 
in a project.

2) [External Notification Information]
Enable the device setting to output the execution status of a recipe, including a recipe process error.

3) [Advanced Setting]

Item Description

[External Control Device]
Controls the writing and reading of device values, and the file format conversion.
The device set in [External Notification Device] cannot be set here.

➟■1 [External Control Device]

[Recipe No. Storage Device]

Specifies the target recipe number when the device set in [External Control Device] 
controls the writing and reading of device values and the file conversion.
One of the consecutive devices starting from the device set in [External Control Device] is 
set automatically.

[Record No. Storage Device]

Specifies the target record number when the device set in [External Control Device] 
controls the writing and reading of device values and the file conversion.
One of the consecutive devices starting from the device set in [External Control Device] is 
set automatically.

Item Description

[External Notification Device]
Notifies the execution status of writing or reading device values.
The device set in [External Control Device] cannot be set here.

➟■2 [External Notification Device]

[Recipe No. Notification Device]
Stores the recipe number of a recipe being processed by the trigger device.
One of the consecutive devices starting from the device set in [External Notification Device] 
is set automatically.

[Record No. Notification Device]
Stores the record number of a recipe being processed by the trigger device.
One of the consecutive devices starting from the device set in [External Notification Device] 
is set automatically.

Item Description

[Enable recipe file operation on the monitor]

Not available to GT21 and GS21.
Incorporates a system application (extended function), which is required for using the 
recipe operation window, into package data.
To display the recipe operation window on the monitor screen, set a special function switch 
([Switch Action]: [Recipe Information]).

➟8.2.9 [Special Function Switch] dialog
For the operations of the recipe operation window, refer to the following.

➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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■1 [External Control Device]

The following table lists the functions of each bit of the device set in [External Control Device].
For the functions of the external notification device, refer to the following.

➟■2 [External Notification Device]

■2 [External Notification Device]

The following table lists the functions of each bit of the device set in [External Notification Device].
For the functions of the external control device, refer to the following.

➟■1 [External Control Device]

Bit number Signal name Function

b0 Recipe-shared Trigger Write signal
When this signal turns on, values are written to the target devices by using the recipe 
setting and record specified with [Recipe No. Storage Device] and [Record No. Storage 
Device].

b1 Recipe-shared Trigger Read signal
When this signal turns on, values are read from the target devices by using the recipe 
setting and record specified with [Recipe No. Storage Device] and [Record No. Storage 
Device].

b2 to b7 Use prohibited -

b8 Convert Recipe File signal

The operation varies depending on the recipe data save destination setting.
• For the data storage (recipe file)
When this bit turns on, the recipe file (*.G2P) corresponding to the recipe data specified 
with [Recipe No. Storage Device] is converted to CSV or Unicode text format.
Set the file format of the conversion destination file in the [File Save] tab in the [Recipe] 
dialog.
If a recipe file having the same name exists, the recipe file is overwritten.
• For the SRAM user area
When this bit turns on, the recipe data specified with [Recipe No. Storage Device] is 
exported to a recipe file.
Set the file format of the export destination file in the [File Save] tab in the [Recipe] 
dialog.
If a recipe file having the same name exists, the recipe file is overwritten.

b9 Reverse-convert Recipe File signal

The operation varies depending on the recipe data save destination setting.
• For the data storage (recipe file)
When this bit turns on, the recipe file corresponding to the recipe data specified with 
[Recipe No. Storage Device] is converted from CSV or Unicode text format to binary 
format (*.G2P).
Set the file format of the conversion source file in the [File Save] tab in the [Recipe] 
dialog.
If a recipe file having the same name exists, the recipe file is overwritten.
• For the SRAM user area
When this bit turns on, the recipe data specified with [Recipe No. Storage Device] is 
imported from the relevant recipe file to the SRAM user area.
Set the import source file in the [File Save] tab in the [Recipe] dialog.

b10 to b14 Use prohibited -

b15 Clear Recipe Processing Error signal When this signal turns on, the Recipe Processing Error Notification signal (External 
notification device.b15) turns off.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Bit number Signal name Function

b0 Recipe-shared Write-in-progress signal

Turns on while the Recipe-shared Trigger Write signal (External control device.b0) is on or 
values are being written with the write trigger device of each recipe setting. 
Turns off when all of the following conditions are satisfied.
• The writing process is complete.
• The Recipe-shared Trigger Write signal (External control device.b0) is off, or the write 

trigger condition of each recipe setting is not satisfied.

b1 Recipe-shared Read-in-progress signal

Turns on when the Recipe-shared Trigger Read signal (External control device.b1) is on or 
values are being read with the read trigger device of each recipe setting. 
Turns off when all of the following conditions are satisfied.
• The reading processing is complete.
• The Recipe-shared Trigger Read signal (External control device.b1) is off, or the read 

trigger condition of each recipe setting is not satisfied.

b2 to b3 Use prohibited -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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b4 Recipe-shared Write Completed signal
Turns on when the Recipe-shared Trigger Write signal (External control device.b0) is on, 
or the writing process with the write trigger device of each recipe setting is complete. 
Turns off when a next writing or reading process starts.

b5 Recipe-shared Read Completed signal
Turns on when the Recipe-shared Trigger Read signal (External control device.b1) is on, 
or the reading process with the read trigger device of each recipe setting is complete. 
Turns off when a next writing or reading process starts.

b6 to b7 Use prohibited -

b8 Recipe File Converting Notification signal

Turns on when the file conversion is started by the Convert Recipe File signal (External 
control device.b8). 
Turns off when all of the following conditions are satisfied.
• The file conversion is complete.
• The Convert Recipe File signal (External control device.b8) is off.

b9 Recipe File Reverse-converting 
Notification signal

Turns on when the file conversion is started by the Reverse-convert Recipe File signal 
(External control device.b9). 
Turns off when all of the following conditions are satisfied.
• The file reverse conversion is complete.
• The Reverse-convert Recipe File signal (External control device.b9) is off.

b10 Recipe File Conversion Error Notification 
signal

Turns on at the end of the file conversion started by the Convert Recipe File signal (External 
control device.b8), if an error occurs during the conversion and the target file is not 
converted properly. 
Turns off when a next conversion of a recipe file starts.

b11 Recipe File Reverse-conversion Error 
Notification signal

Turns on at the end of the file conversion started by the Reverse-convert Recipe File signal 
(External control device.b9), if an error occurs during the conversion and the target file is 
not converted properly. 
Turns off when a next reverse conversion of a recipe file starts.

b12 Recipe Processing (Trigger Disabled) 
Notification signal

Turns on during either of the following processing and notifies that the operations (including 
file conversion) from external control devices cannot be performed.
• Recipe processing (including reading of recipe information for display) from the recipe 

display (record list)
• Import/export of a recipe file using a special function switch
Turns off when the above processing is completed.

b13 Recipe File Reverse-conversion Warning 
Error Notification signal

Turns on at the end of the file conversion started by the Reverse-convert Recipe File signal 
(External control device.b9), if any of the following mismatches is found between the recipe 
setting and the target recipe file at the conversion.
• Recipe setting

[Include device comments in conversion target] is not selected in the [Basic] tab in the 
[Recipe] dialog.

➟9.3.7 ■1 [Basic] tab
• Recipe file

[DEVCMT_CNV] (number of characters in the device comment to be converted) is input 
in the edited recipe file.

➟9.3.2 ■4 (3) Configuration of the recipe file
Turns off when a next reverse conversion of a recipe file starts.

b14 Screen Displaying (Trigger Disabled) 
Notification signal

Turns on while either of the following window is displayed and notifies that the operations 
(including file conversion) from external control devices cannot be performed.
• Recipe operation window
• [Recipe Information] window
Turns off when the above screen disappears.

b15 Recipe Processing Error Notification 
signal

Turns on if an error occurs during the recipe process (such as writing or reading) started by 
an external control device and the process is performed improperly. 
A system alarm occurs when this signal turns on. Check the message and remove error 
causes. 
After the error causes are removed, even if this signal is on, the recipe process (such as 
writing or reading) can be performed. 
One of the following operations turns off this signal.
• Turn on the Clear Recipe Processing Error signal (External control device.b15).
• Start another process with the external control device.

Bit number Signal name Function
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(1) Operation of the external control device and external notification device
The following shows the ON/OFF timing of each signal.
Example) Behavior of the signal at writing
• When the process ends successfully

• When the process ends abnormally

(2) Handshake by the notification signal
To ensure that a process is performed, use the notification signal to establish a handshake.
Example) Handshake established by the Recipe-shared Write-in-progress signal (External notification device.b0)
Confirm that the Recipe-shared Write-in-progress signal (External notification device.b0) is on. Then, turn off the Recipe-
shared Trigger Write signal (External control device.b0) to ensure that the writing process is performed.

Recipe-shared Trigger Write signal
(External control device.b0) 

Recipe-shared Write-in-progress signal
(External notification device.b0)

Recipe-shared Write Completed signal
(External notification device.b4)

A next writing process is executed.

Recipe Processing Error Notification signal 
(External notification device.b15) 

OFF

OFF

OFF

OFF

ON

ON

ON

Writing process

OFF

OFF

OFF

OFF

ON

ON

The writing process cannot 
be executed until error causes are 
removed.

Recipe-shared Trigger Write signal
(External control device.b0) 

Recipe-shared Write-in-progress signal
(External notification device.b0)

Recipe-shared Write Completed signal
(External notification device.b4)

Recipe Processing Error Notification signal 
(External notification device.b15) 

ON

Writing process

Error occurred

Recipe-shared Trigger Write signal
(External control device.b0) 

Writing process

Recipe-shared Write-in-progress signal 
(External notification device.b0)

ON

OFF

ON

OFF

ON

OFF

Check that Recipe-shared Write-in-progress signal is on, 
and then turn off the Recipe-shared Trigger Write signal
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9.3.6 [Recipe List] dialog

Displays the list of the recipe settings and manages the settings.
Select [Common] → [Recipe] → [Recipe] from the menu to display the following dialog.

1) Recipe setting list
List of recipe settings in a project

2) [New] button
Displays the [Recipe] dialog to create a recipe setting.

➟9.3.7 [Recipe] dialog
3) [Edit] button

Displays the [Recipe] dialog to edit a recipe setting selected in the recipe setting list.
➟9.3.7 [Recipe] dialog

4) [Copy] button
Copies a recipe setting selected in the recipe setting list.

5) [Paste] button
Displays the [Copy Recipe Setting] dialog to create a recipe setting by using a copied recipe setting.

6) [Delete] button
Deletes a recipe setting selected in the recipe setting list.

7) [Delete All] button
Deletes all the recipe settings.

8) [Recipe Common Setting] button
Displays the [Recipe Common Setting] dialog.

Item Description

[No.] Recipe number of each recipe setting

[Recipe Name] Recipe name of each recipe setting

• [Destination No.]
Set the recipe number of a recipe setting, which is created by using 
a copied recipe setting.
The setting range is [1] to [32767].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

4)

3)

2)

6)

7)

8)

1)
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9.3.7 [Recipe] dialog

➟■1 [Basic] tab
■2 [Device] tab
■3 [File Save] tab

■1 [Basic] tab

Configure the recipe file setting, and set the write and read trigger devices per recipe setting.

1) [Recipe No.]
Set the recipe number of a recipe setting.
The setting range is [1] to [32767].

➟9.3.2 ■1 Contents of a recipe setting
2) [Recipe Name]

Set the name of a recipe setting.
Up to 32 characters can be set.

3) [Recipe Data]
Configure the settings to save recipe data.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

3)

2)

5)
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➟9.3.2 ■4 Specifications of the recipe file

Item Description

[Recipe Data Save Location]

Set the destination to save recipe data.
The following shows selectable items.
• [Data Storage (Recipe File)(read and write)]
Saves recipe data to a recipe file in the data storage.
• [Embedded Memory in GOT (read and write)]
Not available to GT21 and GS21.
Saves recipe data to the SRAM user area.
No recipe file is created.
• [Not save (record value write only)]
Does not save recipe data.
No recipe file is created.

The recipe data is handled differently depending on the save destination setting.
For the details, refer to the following.

➟9.3.2 ■3 Recipe data

[File Format]

Set this item when [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read 
and write)].
Select a file format of the recipe file.

➟9.3.2 ■4 (2) Recipe file format
The following shows the items to be selected.
• [G2P (Binary)]

A recipe file is created in binary format (*.G2P).
• [Unicode Text]

A recipe file is created in Unicode text format (*.TXT).
• [CSV]

A recipe file is created in CSV format (*.CSV).

[Drive Name]
Set this item when [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read 
and write)].
Select a drive at which a recipe file is located on the GOT.

[Folder Name]

Set this item when [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read 
and write)].
Specify a folder to which a recipe file is saved on the GOT.
For the restrictions on the folder name used with the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
When [File Format] is set to [Unicode Text] or [CSV], recipe files are created for each 
record.
You are recommended to specify different folders to save each recipe file.
When [Drive Name] is set to [C:Built-in Flash Memory] or [D:Built-in SRAM], "\recipe" 
specified with [Package Folder Name] in the [Type Setting] dialog is applied as the folder 
name.

[File Name]

Set this item when [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read 
and write)].
Set the name of a recipe file.
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

[Date Format]

Set this item when [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read 
and write)] or [Embedded Memory in GOT (read and write)].
Select a date format in which the record update date is displayed.
The following shows selectable items.
• [yy/mm/dd]
• [mm/dd/yy]
• [dd/mm/yy]

[Include device comments in conversion 
target]

Set this item when [File Format] is set to [G2P (Binary)].
Enables device comments to be edited when a recipe file is converted from binary format 
(*.G2P) to Unicode text or CSV format.
Includes device comments in the conversion target when a recipe file is converted back to 
binary format (*.G2P).

[Maximum number of characters]

Set this item when [Include device comments in conversion target] is selected.
Set the number of characters in a device comment to be converted when a recipe file is 
converted back to binary format (*.G2P).
The setting range is [1] to [32].
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])

9 - 255



4) [Trigger device]
Set the write and read trigger devices.

➟6.1.2 How to set devices

5) [Create a new recipe display (record list)] button
Not available to GT21 and GS21.
This item is not displayed when the [Recipe] dialog is called up from the [Recipe Display (Record List)] dialog.
Displays the [Screen Selection] dialog.
Select a screen to place a recipe display (record list).

Item Description

[Write Trigger 1], [Write Trigger 2]

Set a device to be written and a trigger condition (ON, OFF).
Set [Write Trigger 2] to execute the writing when two conditions are satisfied.
In that case, device values are written only when the trigger conditions of both the trigger 
device 1 and 2 are satisfied.

[Read Trigger 1], [Read Trigger 2]

Set a device to be read and a trigger condition (ON, OFF).
Set [Read Trigger 2] to execute the reading when two conditions are satisfied.
In that case, device values are read only when the trigger conditions of both the trigger 
device 1 and 2 are satisfied.

[Record No. Device]

Set a device that specifies the target record number when the trigger device of each recipe 
setting starts the writing or reading process.
When the number of records is one, record 1 is always specified, and thus no setting is 
required.

• [Screen Type]
Select the type of a screen to place a recipe display (record list).
The following shows the items to be selected.
[Base Screen]
[Window Screen]

• [Screen No.]
Select the screen number of a screen to place a recipe display 
(record list).
The setting range is [0] to [32767].
A target screen is selectable from among screen titles as well.
To place a recipe display (record list) on a new screen, select [A new 
screen will be created.] for the screen title.
Click the [Browse] button to select a screen in thumbnail view in the 
[Screen Image List] dialog.

• [Screen Type]
Select the type of a screen to be opened.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

Screen title

Screen image list

Jump
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■2 [Device] tab

Set the target devices and the initial values of records.

Selecting Unicode for the character code of the target device for a recipe display
Available to GT27, GT25, GT23, GT SoftGOT2000, and GS25.
When [Character Code] is set to [Unicode] for a target device, if you specify the device for a text display, text 
input, or text print object, configure the settings in the object setting dialog as shown below.
(1) When [Storage Order] is set to [Low-->High] in the [Recipe] dialog

• Select [Unicode] for [Character Code] in the [Device/Style] tab or in the [Text Print] dialog.
• Select [Display in order of High -> Low] in the [Extended] tab or in the [Text Print] dialog.

(2) When [Storage Order] is set to [High-->Low] in the [Recipe] dialog
• Select [Unicode] for [Character Code] in the [Device/Style] tab or in the [Text Print] dialog.
• Deselect [Display in order of High -> Low] in the [Extended] tab or in the [Text Print] dialog.

1) [Block Number]
Set the number of blocks of the recipe setting.
The setting range is [1] to [2048].

➟9.3.2 ■1 (1) Block
2) [Record Number]

Set the number of records of the recipe setting.
The setting range is [1] to [2000].

➟9.3.2 ■1 (3) Record

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

15)

5)4)3)

9)
8) 14)

13)
12)

11)
10)

7)
6)

2)1)
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3) [Character Code]
Set this item when [String] is selected for [Device Type] in a block.
Select the character code to be applied to the value of devices whose [Device Type] is set to [String].
The following shows the items to be selected.

• [ASCII]
• [Unicode]
• [S-JIS]
• [GB]
• [KS] (for GT27, GT25, GT23, GT SoftGOT2000, and GS25)
• [Big5]

4) [Storage Order]
Set this item when [String] is selected for [Device Type] in a block.
Select an order in which data is stored to the devices whose [Device Type] is set to [String].
The following shows the items to be selected.

• [Low-->High]
• [High-->Low]

5) [Record Attribute] button
Displays the [Record Attribute] dialog to set the attribute of a record selected in the target device list.
You can select multiple records by drugging on the record title column.

6) [Insert Block] button
Inserts a block above the block selected in the target device list.

7) [Insert Record] button
Inserts a record in the left of the record selected in the target device list.

8) [Cut] button
Cuts an editable cell selected in the target device list.

9) [Copy] button
Copies an editable cell selected in the target device list.

10) [Paste]
Pastes the cut or copied data in the selected cell.

11) [Clear]
Clears data of a cell or record selected in the target device list.

12) [Delete]
Deletes a block or record selected in the target device list.

13) [Import]
Imports a recipe setting file which is exported with GT Designer3, and overwrites the existing setting in the [Device] 
tab.
Files of recipe settings or advanced recipe settings exported with the following software can also be imported.

• GT Designer3 Version1 (GOT1000)
• GT Designer2 Version2

Recipe files created on the GOT cannot be imported.
14) [Export]

Saves the setting in the [Device] tab with a Unicode text or CSV file.
You can edit the exported file in spreadsheet software and others.
The edited file can be imported with GT Designer3.
The following shows the file format of the exported file.

• [Record No.]
Record number of a selected record
This item is not displayed when multiple record are selected.

• [Record Name]
Set the record name.
Up to 32 characters can be set.

• [Not set the device value]
Set no initial value for a record.
A record without values cannot be used for writing.
Set a value by reading device values or editing the recipe file.

• [Not overwrite the device value in recipe data]
Protects the record from being overwritten.
Device values cannot be written to a record, which is protected 
from being overwritten.
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When importing or exporting files in the multiple-language input environment, use Unicode text files.
The characters of multiple languages can be imported or exported normally by using Unicode text files.

15) Target device list
Lists the target devices and records set in blocks

Item Description

[Device]
Set the devices from which values are read or to which values are written.

➟6.1.2 How to set devices

[Device Type]

Select the data type of devices in each block.
The following shows the items to be selected.
• [Bit]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]
• [String]

[Points]

Set the number of target devices set in each block.
Devices starting from the start device are set sequentially for the set number.
The maximum number of devices that can be set depends on the setting of [Device Type].
• When [Bit] is selected: [1] device
• When [Signed BIN16], [Unsigned BIN16], [Signed BIN8], [Unsigned BIN8], or [BCD16] is 

selected:
256 records or less: [1] to [32768] devices
257 records or more: [1] to [8192] devices

• When [Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)] is selected:
256 records or less: [1] to [16384] devices
257 records or more: [1] to [4096] devices

• When [Signed BIN64], [Unsigned BIN64], [BCD64], or [Real(64bit)] is selected:
256 records or less: [1] to [8192]
257 records or more: [1] to [2048]

• When [Text] is selected: [1] to [2048] devices
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[Character Count (one-byte)] ([Character 
Count] when [Unicode] is selected for 
[Character Code])

Maximum number of characters to be collected.
This item is displayed when [String] is selected for [Device Type]
The settings of [Points] and [Character Code] determine the setting value.
• When [Unicode] is selected for [Character Code]

The maximum number of characters equals the value in [Points].
• When an item other than [Unicode] is selected

The maximum number of characters equals the value in [Points] multiplied by 2.
A two-byte character is counted as two characters.

[Display Type]
Select the display type of a device when its data is output into a CSV or Unicode text file.
The setting range depends on the setting of [Device Type].

➟(1) Relationship between the record setting range and [Device Type] and [Display Type]

[Real Expression]

Select the expression type of the real number.
Set this item when [Real] is selected for [Display Type].
The following shows the items to be selected.
• [Exponential Expression]
• [Fixed Decimal]
Example) When 12345 is set as the record value and 3 is set in [Decimal Point]
• Display in [Exponential Expression]: 1.235E+004
• Display in [Fixed Decimal]: 12345.000

[Decimal Point]
Set the number of digits of decimal numbers.
Set this item when [Real] is selected for [Display Type].
The setting range is [0] to [32] digits.

[Device Comment]
Set the comment for a target device.
Up to 32 characters can be set.

Record

Combinations of device values specified at writing or reading
The device values displayed in the records are adjusted according to the settings of 
[Display Type], [Real Expression], and [Decimal Point].
The values may differ when the settings in the [Device] tab are exported.
Set values are the initial values of a record.
Record columns are created corresponding to the setting of [Record Number].

➟9.3.2 ■1 (3) Record
The setting range of the record initial value depends on [Device Type] and [Display Type].

➟(1) Relationship between the record setting range and [Device Type] and [Display Type]
Click a column header of the table to display the [Edit] button on the header.
Click the [Edit] button to display the [Record Attribute] dialog, and set the attributes of the 
relevant record.

• [Record No.]
Record number of a selected record.
This item is not displayed when multiple record are selected.

• [Record Name]
Set the record name.
Up to 32 characters can be set.

• [Not set the device value]
Set no initial value for a record.
A record without values cannot be used for writing.
Set a value by reading device values or editing the recipe file.

• [Not overwrite the device value in recipe data]
Protects the record from being overwritten.
Device values cannot be written to a record, which is protected from being overwritten.

Item Description
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(1) Relationship between the record setting range and [Device Type] and [Display Type]
The setting items of [Display Type] depend on the setting of [Device Type].
The device value range that can be set for records depends on the setting of [Display Type].

[Device Type] [Display Type] Range of device values

[Bit]
[Bin]

0, 1
[Bit]

[Signed BIN16]

[Signed Dec] -32768 to 32767

[Hex] 0000 to FFFF

[Octal] 000000 to 177777

[Bin] 0000000000000000 to 1111111111111111

[Real] -32768 to 32767

[Unsigned BIN16]

[Unsigned Dec] 0 to 65535

[Hex] 0000 to FFFF

[Octal] 000000 to 177777

[Bin] 0 to 1111111111111111

[Real] 0 to 65535

[Signed BIN32]

[Signed Dec] -2147483648 to 2147483647

[Hex] 00000000 to FFFFFFFF

[Octal] 00000000000 to 377777777777

[Bin] 00000000000000000000000000000000 to 
11111111111111111111111111111111

[Real] -2147483648 to 2147483647

[Unsigned BIN32]

[Unsigned Dec] 0 to 4294967295

[Hex] 00000000 to FFFFFFFF

[Octal] 00000000000 to 37777777777

[Bin] 0 to 11111111111111111111111111111111

[Real] 0 to 4294967295

[Signed BIN64]

[Signed Dec] -9223372036854775808 to 9223372036854775807

[Hex] 0000000000000000 to FFFFFFFFFFFFFFFF

[Real] -9223372036854775808 to 9223372036854775807

[Unsigned BIN64]

[Unsigned Dec] 0 to 18446744073709551615

[Hex] 0000000000000000 to FFFFFFFFFFFFFFFF

[Real] 0 to 18446744073709551615

[Signed BIN8]

[Signed Dec] -128 to 127

[Hex] 00 to FF

[Octal] 000 to 377

[Bin] 00000000 to 11111111

[Real] -128 to 127

[Unsigned BIN8]

[Unsigned Dec] 0 to 255

[Hex] 00 to FF

[Octal] 000 to 377

[Bin] 00000000 to 11111111

[Real] 0 to 255

[BCD16]
[Unsigned Dec]

0 to 9999
[Real]

[BCD32]
[Unsigned Dec]

0 to 99999999
[Real]
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(2) Changing the number of records
The number of records in a recipe is not changeable on the GOT.
If you perform record reading, preset several blank records that have no name and device value.
Doing so enables you to add new records on the GOT by overwriting the blank records.

■3 [File Save] tab

Configure the settings to convert a recipe file (*.G2P) to a different format, and import/export recipe data to/from the 
SRAM user area.
For the details, refer to the following.

➟9.3.3 ■4 Converting a recipe file
The [File Save] tab does not appear when the following settings are made in the [Basic] tab.

• [Recipe Data Save Location] is set to [Not save (record value write only)].
• [File Format] is set to [Unicode Text] or [CSV].

[BCD64]
[Unsigned Dec]

0 to 9999999999999999
[Real]

[Real(32bit)] [Real] 0, ±(1.175494e-038 to 3.402823e+038)

[Real(64bit)] [Real] 0, ±(2.2250738585073e-308 to 1.7976931348623e+308)

[String] [String]

The settings of [Points] and [Character Code] determine the 
setting value.
• When [Unicode] is selected for [Character Code]

The maximum number of characters equals the value in 
[Points].

• When an item other than [Unicode] is selected
The maximum number of characters equals the value in 
[Points] multiplied by 2.
A two-byte character is counted as two characters.

[Device Type] [Display Type] Range of device values

Blank record with no name and device value

D300

D301

D302

D303

76

7

17

0

74

8

18

0

Record No. 1 Record No. 2 Record No. 3 Record No. 4Device

・ Recipe No. 1

Product A Product B

Record No.

Record name

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
9 - 262 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.3 Executing the Batch Write or Batch Read on Multiple Devices ([Recipe])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

1) [Enable the file conversion external control]

Allows the file conversion to be controlled by an external control device.
➟9.3.5 ■1 [External Control Device]

2) [Convert Format]
Select the file format after the conversion.
The following shows the items to be selected.

• [Unicode Text]
• [CSV]
• [G2P (Binary)] (only for saving recipe data to the SRAM user area)

3) [Destination]
If the save destination of recipe data is set to the data storage (recipe file), set the destination path of the conversion 
destination file.
To change the destination from the one where a recipe file is saved, select [Change] and set [Drive Name] and 
[Folder Name].
If the save destination of recipe data is set to the SRAM user area, set the destination path of the export destination 
file or import source file.
Set [Drive Name], [Folder Name], and [File Name].

4) [File Name Specification]
If the save destination of recipe data is set to the data storage (recipe file), set the name of the conversion 
destination file.
Set a file name of the converted file.
To change the file name from the one of the recipe file, select [Change] and set [File Name].

1)
2)
3)

4)

When [Recipe Data Save Location] is set to [Embedded Memory in GOT (read and write)]

When [Recipe Data Save Location] is set to [Data Storage (Recipe File)(read and write)]

2)
3)
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9.3.8 [Recipe File Conversion] dialog

Convert the file format of a recipe file.
Select [Tools] → [Resource Data Conversion] → [Recipe File] from the menu to display the following dialog.

1) [Source of Conversion]

2) [Destination File]

Item Description

[Type]

Select a file type of the conversion source file. 
The following shows the items to be selected.
• [CSV]
• [Unicode Text]
• [G2P]

[Path] Specify a path of the conversion source file.

[Convert all recipe files in the 
same path]

Converts the recipe files, which are in a format selected for [Type], in a specified path. 
A conversion log is created in the specified path. 
The full path of the conversion destination files, the conversion results (OK or NG), and the creation date 
of files are output to the conversion log.

Item Description

[Type]

Select a file type of a file to be created after the conversion. 
The following shows the items to be selected.
• [CSV]
• [Unicode Text]
• [G2P]

[Path] Displays the path of a file to be saved at the destination, which is the same path as the one of the 
conversion source file.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

C:\recipe\ARP00001.txt  OK  20141105150551
C:\recipe\ARP00002.txt  OK  20141105150551
C:\recipe\ARP00003.txt  OK  20141105150551
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9.3.9 Relevant settings

Set the relevant settings other than the specific settings for the recipe function as required. The following shows the 
functions that are available by the relevant settings.

■1 GOT environmental settings (System information)

Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

Difference between the external notification device and system information
The following shows differences between the external notification device and system signal, both of which 
notify the recipe processing status.
(1) External notification device

(2) System information

To establish a handshake, use the external notification device.
➟9.3.5 ■2 [External Notification Device]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying that the recipe process (reading or writing) is being executed (Write device: System signal 2-
1.b10) [System Signal 2-1]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Recipe-shared Write-in-progress
signal (External notification
device.b0)

Recipe-shared Read-in-progress
signal (External notification
device.b1)

DescriptionSignal

Turns on while the Recipe-shared Trigger Write signal (External control
device.b0) is on or values are being written with the write trigger device
of each recipe setting.
Turns off when all of the following conditions are satisfied.
The writing process is complete.
The Recipe-shared Trigger Write signal (External control device.b0)
is off, or the write trigger condition of each recipe setting is not satisfied.

Turns on when the Recipe-shared Trigger Read signal (External control
device.b1) is on or values are being read with the read trigger device
of each recipe setting.
Turns off when all of the following conditions are satisfied.
The reading processing is complete.
The Recipe-shared Trigger Read signal (External control device.b1)
is off, or the read trigger condition of each recipe setting is not satisfied.

System signal 2-1.b10

DescriptionSignal

Turns on during the writing or reading process started by the following
signals.
･Recipe-shared Trigger Write signal (External control device.b0)
･Recipe-shared Trigger Read signal (External control device.b1)
･Write trigger device of each recipe setting
･Read trigger device of each recipe setting
Turns off when the writing or reading process is complete, regardless
of the status of the trigger device.
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■2 GOT Internal Device

➟12.1.3 GOT special register (GS)

Function Setting item

Turning on when a recipe file is imported with an applicable special function switch (Write device) (Write device) GS1010.b0

Turning on when a recipe file is exported with an applicable special function switch (Write device) GS1010.b1

Turning on when the recipe special control is executed (Write device) GS1010.b2

Turning on after a recipe file is successfully imported or exported with an applicable special function switch (Write device) GS1010.b14

Turning on when a recipe file is unsuccessfully imported or exported with an applicable special function switch (Write device) GS1010.b15

Notifying the result of the recipe special control (Write device) GS1011

Notifying the search result of the recipe special control (Write device) GS1012

Changing the character code to Unicode at the following timing
• When a binary file is converted to CSV format
• When data is written to or read from a recipe file in CSV format
(Read device)

GS522.b2

Executing the recipe special control (Read device) GS1800.b2

Turning off the Touch Switch Operation Completed signal (GS1010.b14) and the Touch Switch Operation Error signal 
(GS1010.b15) of the Recipe Status device (Read device) GS1800.b14

Specifying the action of the recipe special control (Read device) GS1801

Specifying the target of the recipe special control (Read device) GS1802

Specifying the start device number of the GOT data registers (GD) that are used for the recipe special control (Read device) GS1803

Specifying the target recipe setting for the recipe special control (Read device) GS1805

Specifying the target record for the recipe special control (Read device) GS1806

Specifying the target start row for the recipe special control (Read device) GS1807

Specifying the number of target rows (starting from the specified start row) for the recipe special control (Read device) GS1808

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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9.4 Transferring Data between Devices ([Device Data Transfer])

9.4.1 Overview of the device data transfer function

Values can be read from specified devices and written into other devices with a trigger or at intervals.

By making device data transfers, the data of controllers can be collected without any sequence program.
• Collecting the data of controllers without making device data transfers
A sequence program is required to collect the data of controllers. (The GOT only monitors the data.)

• Collecting the data of controllers making device data transfers
If device data transfers are set, no sequence program is required.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Trigger condition   : Rising edge of D0.b0
Source device       : D100 of controller 1
Destination device: R100 of controller 2

Device Data Transfer
D0.b0: 0 → 1
Condition is 

satisfied!!

Source device
D100: 200

 

Controller 1

 Destination device
R100: 0 → 200

Controller 2

Sequence program for collecting data

Data collecting (sequence program)

Device data transfer setting

Data collecting (device data transfer)
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9.4.2 Specifications of device data transfer

■1 System application (extended function)
To use the device data transfer, a system application (extended function) of [Device Data Transfer] is required.
Configuring one or more device data transfer settings incorporates the application into the package data automatically.
To use the function on GT SoftGOT2000, the application is not required.

■2 Number of settings
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 255 settings can be configured for one project.

• For GT21 and GS21
Up to 32 settings can be configured for one project.

➟9.4.2 ■4 Data structure of device data transfer settings

■3 Trigger to make device data transfers
Any one of the following triggers is used as a trigger for device data transfers.
• Rising edge of the trigger device
• Falling edge of the trigger device
• Cycle

■4 Data structure of device data transfer settings
If multiple settings of the following items are made, multiple device data transfers can be set for one device data transfer 
setting and device data transfer settings can be set for one project.
• [Device Data Transfer ID]
• [Block Number]

(1) Device Data Transfer ID
Device data transfer ID is ID numbers for identifying each device data transfer setting.
Set the numbers in the [Basic] tab in the [Device Data Transfer] dialog.

➟9.4.6 ■1 [Basic] tab

(2) Block
Blocks are units that divide device numbers and device types into groups.
The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Up to 2048 blocks can be set for one device data transfer setting (ID).

• For GT21 and GS21
Up to 1000 blocks can be set for one device data transfer setting (ID).

By setting transfers by block, the following settings can be made.
• A device data transfer setting that involves multiple device types (such as bit or word)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

レシピレシピ

Max. 255

Device Data Transfer ID  1

Max. 2048 blocks 
Max. 32767 devices
(Total of all blocks)

Block 1

Block 2
Block 3
Block 4
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• A device data transfer setting that mixes together consecutive devices and random devices
The following shows an example of the mix of bit devices and word devices (signed 16-bit binary data and signed 32-bit 
binary data) set for one device data transfer setting.

Set blocks in the [Device] tab in the [Device Data Transfer] dialog.
➟9.4.6 [Device Data Transfer] dialog

(a) Relation between the number of blocks and transfer processing time
When a large number of blocks are set for a device data transfer setting, transfer processing may take a long time.
To shorten the processing time, reduce the number of blocks.
Reference value for connection to a QCPU using the direct CPU connection (serial) (device points: 32767, transmission 
speed: 115200 bps)

• If one block is set: Approximately 15 seconds
• If 2048 blocks are set: Approximately 130 seconds

(3) Device
(a) Number of devices that can be set

The setting range depends on the GOT model.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

Regardless of the device type, up to 32767 devices can be set for one device data transfer ID.
• For GT21 and GS21

Regardless of the device type, up to 1000 devices can be set for one device data transfer ID.
The number of devices to be used depends on the device data type.

• Bit, 8-bit, 16-bit: 1
• 32-bit: 2
• 64-bit: 4

(b) Relation to blocks
A single device number can be set for a single block.
To set consecutive device numbers, set the number of the devices in the same block.
To set device numbers randomly, set the device numbers in different blocks.

Set [Device Type], [Points], [Source Device], 
and [Destination Device] by block.

Specify the number of blocks.

Block 1

Block 2
Block 3
Block 4
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■5 Operations performed when multiple trigger conditions are satisfied simultaneously
(1) When the trigger condition for another device data transfer setting is satisfied while a device data 

transfer is being processed
If the trigger type is set to [Sampling], the GOT does not ignore the satisfied trigger condition, and executes the device 
data transfers subsequently.
If the trigger type is not set to [Sampling], the GOT ignores the satisfied trigger condition.

To execute the device data transfer without fail, select [Rise] for [Trigger Type] then time a handshake with the trigger 
device and Device Data Transfer Notification signal.

Step 1 The device data transfer trigger (Device Data Transfer ID; 1) turns on.
Step 2 The Device Data Transfer Notification signal (Device Data Transfer ID: 1) turns on.

The device data transfer trigger (Device Data Transfer ID: 1) turns off and the device data transfer trigger 
(Device Data Transfer ID: 2) turns on.

Step 3 Following the completion of the device data transfer processing and the off status of the device data transfer 

Device data transfer trigger
(Trigger type: [Rise])

Device Data Transfer 
Notification signal 

(External notification device.b0)

Device data transfer processing 
(GOT)

Device data transfer trigger
(Trigger type: [Sampling])

Device Data Transfer 
Notification signal 

(External notification device.b0)

Device Data Transfer 
Notification signal 

(External notification device.b0)

Ignored!

OFFDevice data transfer trigger
(Trigger type: [Rise])

ONDevice Data Transfer ID 1

Device Data Transfer ID 1

Device Data Transfer ID 2

Device Data Transfer ID 2

Device Data Transfer ID 3

Device Data Transfer ID 3

ON

ON ON

ON

ON

ON

Data transfer
(ID 1)

Data transfer
(ID 2)

Data transfer
(ID 3)

OFF

OFF OFF

OFF

OFF

OFF

Waiting for the completion of data transfer (ID 2)

ON

OFF
ON

Device data transfer trigger
(Trigger type: [Rise])

Device Data Transfer ID 1

OFF
ON

Device data transfer trigger
(Trigger type: [Rise])

Device Data Transfer ID 2

Device Data Transfer Notification signal
 (External notification device.b0)

OFF
ONDevice Data Transfer ID 1

Device Data Transfer Notification signal
(External notification device.b0)

OFF
Device Data Transfer ID 2

Data transfer (ID 1) Data transfer 
(ID 2)

Device data transfer processing 
(GOT)
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trigger (Device Data Transfer ID: 1), the Device Data Transfer Notification signal (Device Data Transfer ID: 1) 
turns off.

Step 4 The next device data transfer is allowed to be processed and the device data trigger (Device Data Transfer 
ID: 2) which turned on in step 2 is enabled.

(2) When trigger conditions for different Device Data Transfer ID numbers are satisfied simultaneously
The device data transfer that has been given the smallest ID number is prioritized.

However, if trigger conditions for multiple device data transfers are satisfied by the time the device data transfer is 
completed, the next device data transfer to be executed is the one that has been given the ID number that is the smallest 
of those larger than the one that has been assigned to the transfer that was already executed.
For example, if the conditions for the device data transfer triggers (Device Data Transfer ID: 1, 3) are satisfied by the time 
the above device data transfer (Device Data Transfer ID: 1) is completed (device data transfer trigger: OFF → ON), the 
device data transfer (Device Data Transfer ID: 3) is the next one to be executed.

OFF

OFFDevice data transfer trigger
(Example: Device Data Transfer ID 1)

Device data transfer trigger
(Example: Device Data Transfer ID 2)

Device Data Transfer Notification signal
(Example: External notification device.
b0 of Device Data Transfer ID 1)

ON

OFF

OFF

ON

ON
Device data transfer trigger
(Example: Device Data Transfer ID 3)

Device Data Transfer Notification signal
(Example: External notification device.
b0 of Device Data Transfer ID 3)

Device Data Transfer Notification signal
(Example: External notification device.
b0 of Device Data Transfer ID 2)

OFF

ON

ON

Device data transfer processing (GOT)

OFF
ON
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9.4.3 How to use device data transfer

■1 Setting procedure
The following shows the procedure for registering a device data transfer setting.

Step 1 Select [Common] → [Device Data Transfer] from the menu.
The [Device Data Transfer List] dialog appears.
➟9.4.5 [Device Data Transfer List] dialog

Step 2 Click the [New] button.
The [Device Data Transfer] dialog appears. A device data transfer setting can be registered.
➟9.4.6 [Device Data Transfer] dialog

Step 3 For the [Basic] tab in [Trigger Type], set the timing with which device data transfers are triggered.

➟9.4.6 ■1 [Basic] tab
Step 4 Set [Source Device] and [Destination Device] in the [Device] tab.

➟9.4.6 ■2 [Device] tab
Step 5 Click the [OK] button.

The [Device Data Transfer] dialog closes.
Step 6 Click the [Close] button.

The [Device Data Transfer List] dialog closes and the registration of the device data transfer setting is complete.

When setting device data transfers, make sure that the data size does not exceed the available space in 
the user area for the GOT.
Depending on the settings, not all the set values (such as the number of devices) can be set to their 
maximum.
For example, if comments are set for each device, the setting size becomes larger.
For details of the capacity of the available user area for the GOT, refer to the following.

➟12.10.1 Data transferred to the GOT and capacity of the destination drive

■2 Operations of device data transfers
(1) Transferring device data

When a set trigger condition is satisfied, the values in the source device values are transferred to the destination devices.

(2) Reversing the data transfer direction (Switching the relation between the source device and 
destination device)
By switching the status of the transfer inverting flag device between on and off, the data transfer direction can be reversed 
accordingly. (The relation between the source and destination is reversed).
Therefore, data transfers in both directions (from the source to the destination and the other way around) can be made 
with one device data transfer setting.
The following shows the procedure for setting the transfer inverting flag device.

Step 1 Select [Common] → [Device Data Transfer] from the menu.
The [Device Data Transfer List] dialog appears.
➟9.4.5 [Device Data Transfer List] dialog

Step 2 Click the [New] button or the [Edit] button.
The [Device Data Transfer] dialog appears.
➟9.4.6 [Device Data Transfer] dialog

Step 3 Set a device for [External Control Device] in the [Basic] tab.

➟9.4.6 ■1 [Basic] tab
6.1.2 How to set devices
Bit 1 of the set device is assigned as the transfer inverting flag device.

The following shows the relation between the transfer inverting flag device and source/destination.
• When the transfer inverting flag device is off
Device data are transferred from the source device to the destination device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• When the transfer inverting flag device is on
Device data are transferred from the destination device to the source device.

Turn on transfer inverting flag device before turning on the trigger device or simultaneously with the trigger device by 
writing a value to the word device.

Using device data transfers instead of scripts
Instead of bmov, the function of scripts, device data transfers can be used.
The device data transfer communication is established only when the corresponding conditions are 
satisfied. On the other hand, the devices in a script require continuous communication. Hence, if device 
data transfers are used, the load due to the continuous communication is not imposed.
For scripts, refer to the following.

➟9.8 Controlling Operations with Scripts ([Script])

■3 Outputting the status of device data transfers to a device
When the external notification device is set, the status of device data transfers (such as the status in which a transfer is in 
the process of being made and presence/absence of an error) can be externally notified.
The following shows the procedure for setting the external notification device.

Step 1 Select [Common] → [Device Data Transfer] from the menu.
The [Device Data Transfer List] dialog appears.
➟9.4.5 [Device Data Transfer List] dialog

Step 2 Click the [New] button or the [Edit] button.
The [Device Data Transfer] dialog appears.
➟9.4.6 [Device Data Transfer] dialog

Step 3 Select [External Notification Device] in the [Basic] tab then set a device.

➟9.4.6 ■1 [Basic] tab
6.1.2 How to set devices
Signals are assigned as shown below.
• Bit 0: Device Data Transfer Notification signal
• Bit 14: BCD Conversion Error Notification signal
• Bit 15: Device Data Transfer Error Notification signal

(1) Device Data Transfer Notification signal (external notification device.b0)
Notifies that a device data transfer is in the process of being made.
• The device data transfer trigger condition is satisfied → the external notification device.b0 turns on.
• No device data transfer trigger condition is satisfied and the device data transfer is complete → the external notification 
device.b0 turns off.

Even if this signal is on, a device data transfer can be made as long as the previous device data transfer has been 
completed.

Source device:
GD100

Destination device:
D100Device Data Transfer

Source device:
GD100

Destination device:
D100Device Data Transfer
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(2) BCD Conversion Error Notification signal (external notification device.b14)
Notifies whether an error has occurred or not during BCD conversion.
• An error occurs during BCD conversion → the external notification device.b14 turns on.
Even if an error occurs, device data are transferred.
However, the device values are not what you intend to transfer. Check the data before restarting the device data transfer.

(3) Device Data Transfer Error Notification signal (external notification device.b15)
Notifies whether an error has occurred or not during a device data transfer.
• An error occurs during a device data transfer → the external notification device.b15 turns on.
• The device data transfer which was executed after an error occurred is normally completed → the external notification 
device.b15 turns off.

The following shows the operations performed when an error occurs and corrective actions for the error.
When an error occurs, the following operations are performed.

Step 1 The Device Data Transfer Error Notification signal (external notification device.b15) turns on.
Step 2 The ID number that has been assigned to the device data transfer that caused the error is stored in Error 

Device Data Transfer ID (GS642).
Step 3 The value in Device Data Transfer Error Count (GS643) is incremented by one every time an error occurs.
Step 4 A system error occurs.

After checking the message, identify the cause of the error and eliminate the error.
Step 5 The device data transfer is restarted.
Step 6 The device data transfer is successfully made and the Device Data Transfer Error Notification signal 

(external notification device.b15) turns off.
To clear Error Device Data Transfer ID (GS642) and Device Data Transfer Error Count (GS643), turn on the 
Device Data Transfer Error Clear signal (GS510.b0).
➟12.1.3 GOT special register (GS)

■4 Importing/exporting settings
You can edit exported Unicode text files and CSV files by using spreadsheet software.
Edited Unicode text files and CSV files can be imported to GT Designer3.
Example) A CSV file

Error 
occurred

ON
OFF

Device data transfer trigger
(Example: Device Data Transfer ID 1)

OFF
ON

ON

ONON

ON
OFF

OFF

0

0

0

0

1

1

Device Data Transfer Notification 
signal (Example: External notification 
device. b0 of Device Data Transfer ID 1)

Device data transfer processing (GOT)

Device Data Transfer Error Notification 
signal (Example: External notification 
device. b15 of Device Data Transfer ID 1)

Error Device Data Transfer ID
(GS642)

Device Data Transfer Error Count 
(GS643)

Device Data Transfer Error Clear 
signal (GS510.b0)
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(1) Format of text files for device data transfers
The format of text files for device data transfers is common to both Unicode text files and CSV files.
However, use the following delimiters for each item.
• Unicode text file: Tab (\t)
• CSV file: Comma (,)
The following shows the format.

Export to a CSV file.

Edit the exported file.

Import from the CSV file to GT Designer3.

Add the settings 
by using applications 
such as spreadsheet software.

The added settings 
are reflected.

1)
2)

3) 4) 5) 6) 7) 8)
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1) Title
Displays "Device Data Transfer".

2) Block Number
Set the number of blocks for device data transfers.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [2048].

• For GT21 and GS21
The setting range is [1] to [1000].

3) Device Type
Set the data type of the device.
The following shows the setting range.

• Bit
• Signed BIN16
• Unsigned BIN16
• Signed BIN32
• Unsigned BIN32
• Signed BIN64
• Unsigned BIN64
• Signed BIN8
• Unsigned BIN8
• BCD16
• BCD32
• BCD64
• Real(32bit)
• Real(64bit)

4) Points
Set the number of the target devices for the transfer by block.
When a start device is set, consecutive devices are automatically specified according to the set number. The number 
of the specified devices including the start device is the same as the number set for this item.

5) Source Device
Set a device from which the value is read.

6) Destination Device
Set a device to which the value read from the source device is written.

7) Comment
Set a comment.
Up to 32 characters can be set.

8) Offset
Set the target for an offset and the offset device.
The following shows the targets that can be set.

• None
• Source
• Destination
• Both

When setting the source, destination, or both, input the offset device.
Insert a one-byte space between the offset target and the offset device.
If incorrectly input data are imported, GT Designer3 regards it as [None].
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(1) Using characters of multiple languages
When importing or exporting files in the multiple-language input environment, use Unicode text files.
The characters of multiple languages can be imported or exported normally by using Unicode text files.
For the precautions for using Unicode text files, refer to the following.
➟12.9 Precautions for Using Unicode Text File

(2) Editing exported files
For the precautions for using a CSV file or Unicode text file, refer to the following.
➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File
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9.4.4 Precautions

■1 Device data transfers and the status of the GOT
Depending on the GOT status, no device data transfer is executed.
The following lists the operations with which no device data transfer is executed.
• When writing BootOS, package data
• When restarting the GOT
If a device data transfer is interrupted by the above operations, the value in a source device cannot be synchronized with 
that in the destination device.
If a device data transfer is interrupted, execute the device data transfer again after the processing of the above operations 
has been completed.

■2 If device data are not transferred as intended
In the following cases, device data may not be transferred normally.
• The communication between the GOT and controllers takes a long time because a large number of devices have been set.
• The intervals for a device data transfer trigger are short. (In a case where the trigger condition is satisfied while the device 
data transfer is still in the process of being made)

• Other functions (such as logging and recipe) have also been set.
Take any one of the following countermeasures against the above situations
• When selecting [Sampling] for the trigger type, reduce the number of devices per device data transfer setting of device 
data transfers made at short intervals (If there are device data transfers that do not require short intervals, set them for 
another device data transfer setting for which long intervals are set.)

• While the Device Data Transfer Notification signal is off, satisfy the trigger condition.
➟9.4.3 ■3 Outputting the status of device data transfers to a device

• If the baud rate can be changed, increase the baud rate with controller settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting for short intervals Setting for long intervals

Cycles: at 10 (× 100ms) Cycles: at 100 (× 100ms)

Cycles: at 10 (× 100ms)

Device data transfer setting

Separate the settings.

Source → Destination Source → Destination

Source → Destination

D100 → D200
D102 → D202
D104 → D204
D106 → D206
D108 → D208

D101 → D201
D103 → D203
D105 → D205
D107 → D207
D109 → D209

D100 → D200
D102 → D202
D104 → D204
D106 → D206
D108 → D208

D101 → D201
D103 → D203
D105 → D205
D107 → D207
D109 → D209

(Device Data Transfer ID 1)

Device data transfer setting
(Device Data Transfer ID 1)

Device data transfer setting
(Device Data Transfer ID 2)
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■3 verlap of source and destination devices
If source devices and destination devices overlap in the same device data transfer setting, the device data may not be 
transferred normally.
If the devices need overlapping, set the overlapping devices for different device data transfer settings.
The following shows an example of settings.
Example) Setting method for transferring the device values of D100, D105, D110 to D110, D115, D120 respectively (D110 
overlaps.)

If the same trigger device (D1000.b0) is set for multiple device data transfer settings, the device data transfers of the device 
data transfer setting that has been given a smaller Device Data Transfer ID number are prioritized.
By transferring D110 prior to D100, the device value in D110 that has yet to be overwritten with the value in D100 can be 
transferred to D120.

If the device data transfers are set for the same device data transfer setting, the value in D100 is transferred prior to D110 
and the device value in D110 is overwritten with that in D100.
Then the device value in D110 is transferred to D120, which means that the device value in D100 is transferred to D120 as 
a result.

Device Data Transfer ID Trigger type Trigger device Number of blocks Source device Destination device

1 Cycle D1000.b0 1 D110 D120

2 Cycle D1000.b0 2
D100 D110

D105 D115

Device Data Transfer ID Trigger type Trigger device Number of blocks Source device Destination device

1 Cycle D1000.b0 3

D110 D120

D100 D110

D105 D115
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9.4.5 [Device Data Transfer List] dialog

When device data transfers are made, values are read from specified devices and are written to other devices with a trigger 
or at intervals.
Select [Common] → [Device Data Transfer] from the menu to display the [Device Data Transfer List] dialog.
The dialog displays the settings of device data transfers in a list and manages them.

1) [Device Data Transfer ID]
Display the ID numbers for identifying each device data transfer setting.

2) [Device Data Transfer Name]
Displays the names of device data transfer settings.

3) [New] button
Creates a new device data transfer setting.

➟9.4.6 [Device Data Transfer] dialog
4) [Edit] button

Changes the settings of a selected device data transfer setting.
➟9.4.6 [Device Data Transfer] dialog

5) [Copy] button
Copies a selected device data transfer setting.

6) [Paste] button
Pastes a copied device data transfer setting.

7) [Delete] button
Deletes a selected device data transfer setting.

8) [Delete All] button
Deletes all the device data transfer settings.

• [Destination ID]
Set a Device Data Transfer ID number.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

6)

3)

4)

7)

8)

1) 2)
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9.4.6 [Device Data Transfer] dialog

Set device data transfer settings.
➟■1 [Basic] tab
■2 [Device] tab

This dialog appears when the [New] button or [Edit] button in the [Device Data Transfer List] dialog is clicked.
➟9.4.5 [Device Data Transfer List] dialog

■1 [Basic] tab

Set the device data transfer trigger and external notification information.

1) [Device Data Transfer ID]
Set an ID number to identify the device data transfer setting.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [255].

• For GT21 and GS21
The setting range is [1] to [32].
➟9.4.2 ■4 Data structure of device data transfer settings

2) [Device Data Transfer Name]
Set the name of the device data transfer setting.
Up to 32 characters can be set.

3) [Device Data Transfer Trigger]
Set a condition under which device values are transferred.

➟9.4.3 ■2 Operations of device data transfers

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Trigger Type]

Select an operating condition that triggers device value transfers.
The following shows the items to be selected.
• [Rise]
• [Fall]
• [Sampling]
When selecting [Sampling], set a cycle in which transfers are executed.
The setting range depends on the GOT model.
• GT27, GT25, GT23, GT SoftGOT2000, and GS25: [1] to [36000]
• GT21 and GS21: [5] to [36000]

[External Control Device]

Set the target device for the operating condition of [Trigger Type].

➟6.1.2 How to set devices
In the following cases, set this item.
• When selecting [Rise] or [Fall]
• When selecting [Sampling] and using [Transfer Inverting Flag Device].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)1)

3)

4)
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4) [External Notification Information]
Set a device that notifies the status of transfers.

➟9.4.3 ■3 Outputting the status of device data transfers to a device

■2 [Device] tab

Displays set source devices and destination devices in a list and manages them.

1) [Block Number]
Set the number of blocks for device data transfers.
The setting range depends on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
The setting range is [1] to [2048].

• For GT21 and GS21
The setting range is [1] to [1000].
➟9.4.2 ■4 Data structure of device data transfer settings

2) [Insert Block] button
Inserts a block above a selected block.

3) [Cut] button
Cuts a selected block.

4) [Copy] button
Copies a selected block.

5) [Paste] button
Pastes a copied block.

[Trigger Device]

When the value in a set device satisfies a set condition, the values in source devices are 
transferred to destination devices.
Bit 0 of the device set for [External Control Device] is specified.
This item is used when [Rise] or [Fall] is selected.

[Transfer Inverting Flag Device]
When a set condition is satisfied, reverses the direction in which device values are 
transferred. (Device values are transferred from the destination to the source.)
Bit 1 of the device set for [External Control Device] is specified.

Item Description

[External Notification Device]
Set a device that receives notifications of the status of device value transfers.

➟6.1.2 How to set devices

[Device Data Transfer Notification Signal]
Notifies that device values are in the process of being transferred.
Bit 0 of the device set for [External Notification Device] is specified.

[BCD Conversion Error Notification Signal]
When an error occurs while a device value in BCD is being transferred, notifies the error.
Bit 14 of the device set for [External Notification Device] is specified.

[Device Data Transfer Error Notification 
Signal]

When an error occurs during a device value transfer, notifies the error.
Bit 15 of the device set for [External Notification Device] is specified.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 4) 6) 8)3) 5) 7) 9)

10)
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6) [Clear] button
Clears a comment.

7) [Delete] button
Deletes a selected block.

8) [Import] button
Imports the settings that were edited in a Unicode text file or CSV file to GT Designer3.

9) [Export] button
Saves the settings made in this tab as a Unicode text file or CSV file.

10) Device list
Lists set devices.

Item Description

[No.] Displays the numbers that show the number of set devices.

[Device Type]

Select the data type of the device to be set.
The following shows the items to be selected.
• [Bit]
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]
Set this item prior to the device setting.
When the device type is changed to another one that has a different data length after a 
device is set, the device setting is cleared.*1*2

[Points]

Set the number of the target devices for the transfer by block.
When a start device is set, consecutive devices are automatically specified according to 
the set number.
The number of the specified devices including the start device is the same as the number 
set for this item.

[Source Device]
Set a device from which the value is read.

➟6.1.2 How to set devices

[Destination Device]
Set a device to which the value read from the source device is written.

➟6.1.2 How to set devices

[Comment]
Set a comment.
A set comment is displayed in Unicode text file and CSV file.
Up to 32 characters can be set.
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*1 Example 1) When changing the device type to another one that has a different data length

*2 Example 2) When changing the device type to another one that has the same data length

[Offset]

Displays the target for an offset and the offset device.

➟6.1.11 Offset

• [Offset Target]
Select an offset target.
The following shows the items to be selected.
• [None]
• [Source]
• [Destination]
• [Both]

• [Data Type]
Select the data type of the device to be set.
The following shows the items to be selected.
• [Signed BIN16]
• [Signed BIN 32]

• [Offset Device]
Set an offset device.
When selecting [Destination], [Source], or [Both] for [Offset Target], set this item.
When [Both] is selected for [Offset Target], a single device can be set for either [Source 
Device] or [Destination Device].

Before After Result

Signed BIN 16 Real(32bit) Because the data length changes from 16 to 32 bits, the settings of [Source 
Device] and [Destination Device] are cleared.

Before After Result

Signed BIN 16 BCD16 Because the data lengths are the same, the settings of [Source Device] and 
[Destination Device] are retained.

Item Description
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9.4.7 Relevant settings

Set the relevant settings other than the specific settings for device data transfers as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Clearing Error Device Data Transfer ID and Device Data Transfer Error Count when turns on (Device Data Transfer Error 
Clear signal) GS510.b0

Clearing Device Data Transfer Processing Time, Device Data Transfer Min. Processing Time, and Device Data Transfer 
Max. Processing Time when turns on (Device Data Transfer Processing Time Clear signal) GS510.b1

If an error occurs when a device data transfer is made, storing the Device Data Transfer ID number that has been assigned 
to the device data transfer that has caused the error (Error Device Data Transfer ID) GS642

Storing the number of the errors that occurs due to device data transfers (Device Data Transfer Error Count) GS643

Storing the processing time of a device data transfer (Device Data Transfer Processing Time) GS644

When the processing time is stored in Device Data Transfer Processing Time, storing the Device Data Transfer ID number 
that has been assigned to the device data transfer that has been completed (Device Data Transfer ID) GS645

Storing the shortest processing time ever stored in Device Data Transfer Processing Time (Device Data Transfer Min. 
Processing Time) GS646

When the shortest processing time is stored in Device Data Transfer Min. Processing Time, storing the Device Data 
Transfer ID number that has been assigned to the device data transfer that has been completed (Device Data Transfer ID 
(Min. Processing Time))

GS647

Storing the longest processing time ever stored in Device Data Transfer Processing Time (Device Data Transfer Max. 
Processing Time) GS648

When the longest processing time is stored in Device Data Transfer Max. Processing Time, storing the Device Data 
Transfer ID number that has been assigned to the device data transfer that has been completed (Device Data Transfer ID 
(Max. Processing Time))

GS649
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9.5 Operating a Device as a Trigger ([Trigger Action])

9.5.1 Overview of the trigger action function

When set conditions are satisfied, various operations can be performed: bit devices are turned on/off, values are written into 
word devices, screens are switched, and sounds are output.

9.5.2 Specifications of trigger action

■1 Types of trigger actions
The following two types of trigger actions are provided.

(1) Trigger actions common in a project
These trigger actions are set globally in a project.
All the devices set globally in a project are monitored.

(2) Trigger actions for each screen
These trigger actions are set for each screen.
The screens for which trigger actions are settable depend on the GOT model.

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
Base screens and window screens

• For GT21 and GS21
Base screens only

Set devices are monitored only while the target screens are displayed by the GOT.
If the set overlay screen function calls the screen for which a trigger action is set, the trigger action will be executed on 
the called screen as well.(Not available to GT21 and GS21)

■2 Number of trigger actions that can be set
Up to 600 trigger actions common in a project can be set. This also applies to trigger actions for each screen.

■3 Number of conditions that can be set
Up to two conditions under which trigger actions are executed can be set.
Select the first condition from the following.
• Ordinary
• Rise
• Fall
• Rise/Fall
• ON
• OFF
• ON Sampling
• OFF Sampling

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Condition is 
satisfied!!

Write

Action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• Sampling
• Range
• Bit Trigger
Select the second condition from the following.
• ON
• OFF
• Sampling
• Bit Trigger
However, if [Ordinary] is set for the first condition, the second condition cannot be set.

■4 Actions that can be executed when set conditions are satisfied
• Making bit devices remain on while set conditions are satisfied.
• Turning on bit devices
• Turning off bit devices
• Switching the status of bit devices between on and off
• Writing values into word devices
• Switching to a specified screen
• Outputting sounds with an external speaker (GT27, GT25, GT SoftGOT2000, and GS25)

■5 Maximum number of write operations
Bit momentary, bit set, bit reset, bit alternate: 40
Data set (8 bits), data set (16 bits), data set (32 bits), data set (64 bits): 20

9.5.3 How to use trigger action

■1 Setting procedure
The following shows the procedure for setting a trigger action.

Step 1 Select [Common] → [Trigger Action] from the menu.
The [Trigger Action] dialog appears.
➟9.5.5 [Trigger Action] dialog

Step 2 When setting a trigger action common in the project, display the [Project] tab.

➟9.5.5 ■1 [Project] tab
When setting a trigger action for a screen, display the [Screen] tab and select the target screen.
➟9.5.5 ■2 [Screen] tab

Step 3 Click the [Add] button.
The [Trigger/Action] dialog appears. A trigger action can be registered.
➟9.5.6 [Trigger/Action] dialog

Step 4 In the [Trigger] tab, set a condition (trigger 1) under which the trigger action is executed.

➟9.5.6 ■1 [Trigger] tab
When executing the trigger action when two conditions are satisfied, select [Trigger2] and set one more 
condition.

Step 5 In the [Action] tab, set the action to be executed when the conditions are satisfied.

➟9.5.6 ■2 [Action] tab
Step 6 Click the [OK] button.

The [Trigger/Action] dialog closes.
Step 7 Click the [OK] button in the [Trigger Action] dialog.

The dialog closes and the registration of the trigger action is complete.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Setting data sets
(1) [Fixed] and [Indirect]

If [Fixed] and [Indirect] are set, a fixed value or the value in a word device is written into the target device.
[Fixed] and [Indirect] can be set together.

(a) [Fixed]
When set conditions are satisfied, the value set for [Fixed] is written into the target device.

(b) [Indirect]
When set conditions are satisfied, the value in the indirect device set for [Indirect] is written into the target device.

When set conditions are satisfied, 
the fixed value (50) is written into D100.

When set conditions are satisfied, 
the value in D200 is written into D100.
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(c) [Fixed] + [Indirect]
When set conditions are satisfied, the total of the value in the indirect device set for [Indirect] and the value set for [Fixed] 
is written into the target device.

(2) FMOV and BMOV
When setting two or more devices and selecting [Indirect], select a write operation that writes values to the target devices.

(a) [FMOV]
When set conditions are satisfied, the value in the word device set for [Indirect] is written into the target devices.

When set conditions are satisfied, the value 
in D200 + the fixed value (50) is written into D100.

When set conditions are satisfied, 
the value in D200 is written into D100 to D104.
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(b) [BMOV]
When set conditions are satisfied, the current values in the word devices individually set for [Indirect] is written into the 
corresponding target devices.

9.5.4 Precautions

■1 Setting multiple trigger actions
When setting multiple trigger actions, set [Network No.] and [Station No.], setting items in the [Trigger/Action] dialog, to the 
same No.

➟9.5.6 [Trigger/Action] dialog

■2 Operation if an error has occurred for a trigger action.
Operation set for the trigger action is stopped when an error occurs.
The operation of all trigger actions are not executed after it is stopped.

When set conditions are satisfied, the values 
in D200 to D204 are written into D100 to D104.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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9.5.5 [Trigger Action] dialog

When set conditions are satisfied, trigger actions are executed then various operations can be performed: bit devices are 
turned on/off, values are written into word devices, screens are switched, and sounds are output.
Select [Common] → [Trigger Action] from the menu.

➟■1 [Project] tab
■2 [Screen] tab

■1 [Project] tab

Displays set trigger actions globally set for the project in a list and manages them.

1) Trigger action list
Lists set trigger actions.

2) [Add] button
Creates a trigger action.

➟9.5.6 [Trigger/Action] dialog
3) [Edit] button

Changes the settings of a selected trigger action.
➟9.5.6 [Trigger/Action] dialog

4) [Copy] button
Copies a selected trigger action.

5) [Paste] button
Pastes a copied trigger action.

6) [Delete] button
Deletes a selected trigger action.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[No.] Number of a trigger action

[Trigger] Trigger condition to execute the corresponding action

[Action] Action to be executed when the trigger condition is satisfied

[Name] Name of a trigger action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)
5)

2)
3)

6)

1)
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■2 [Screen] tab

Displays trigger actions set for each screen in a list and manages them.

1) [Screen Type]
Set the target screen for set trigger actions.
The following shows selectable items.

• [Base]: Uses a base screen.
• [Windows]: Uses a window screen.(Not available to GT21 and GS21)

2) [Screen No.]
Set the screen No. that has been assigned to the target screen for set trigger actions.
Click the [Browse] button to open the screen image.

3) Trigger action list
Lists set trigger actions.

4) [Add] button
Creates a trigger action.

➟9.5.6 [Trigger/Action] dialog
5) [Edit] button

Changes the settings of a selected trigger action.
➟9.5.6 [Trigger/Action] dialog

6) [Copy] button
Copies a selected trigger action.

7) [Paste] button
Pastes a copied trigger action.

8) [Delete] button
Deletes a selected trigger action.

Item Description

[No.] Number of a trigger action

[Trigger] Trigger condition to execute the corresponding action

[Action] Action to be executed when the trigger condition is satisfied

[Name] Name of a trigger action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

6)
7)

4)
5)

8)
3)

1)
2)
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9.5.6 [Trigger/Action] dialog

The [Trigger/Action] dialog is displayed when the [Add] button or [Edit] button in the [Trigger Action] dialog is clicked.
➟■1 [Trigger] tab
■2 [Action] tab

■1 [Trigger] tab

Set conditions under which set trigger actions are executed.

1) Trigger 1 and trigger 2
Previews set conditions.
Up to two conditions can be set.
In cases where two conditions are set, trigger actions are executed when both of the conditions are satisfied.
When selected, the conditions become valid.

2) [Trigger1], [Trigger2]
Set items for a selected condition.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Trigger Type]

Set a condition under which trigger actions are executed.
The following shows selectable items.
Select the first condition from the following.
• [Ordinary]
• [Rise]
• [Fall]
• [Rise/Fall]
• [ON]
• [OFF]
• [ON Sampling]
• [OFF Sampling]
• [Sampling]
• [Range]
• [Bit Trigger]
Select the second condition from the following.
• [ON]
• [OFF]
• [Sampling]
• [Bit Trigger]
However, if [Ordinary] is selected for the first condition, the second condition cannot be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)

2)

4)
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3) [Use offset]
Displays the target for an offset and the offset device.
This item can be set when trigger actions for each screen are set.

4) [Name]
Set the name of a trigger action.
Up to 100 characters can be set.

■2 [Action] tab

Set actions executed when set conditions are satisfied.

1) [Action]
Set actions executed when set conditions are satisfied.
The following shows selectable items.

• [Momentary]: Turns on the target bit devices while the set conditions are satisfied.
Turns off the target bit devices while the set conditions are not satisfied.
The target bit devices cannot be turned on or off by other operations.

• [Set]: Turns on the target bit devices.
• [Reset]: Turns off the target bit devices.
• [Alternate]: Switches the status of the target bit devices between on and off.
• [Data Set 8bit]: Writes values into the target 8-bit devices.
• [Data Set 16bit]: Writes values into the target 16-bit word devices.
• [Data Set 32bit]: Writes values into the target 32-bit word devices.
• [Data Set 64bit]: Writes values into the target 64-bit word devices.
• [Screen Switching]: Switches screens
• [Sound Output]: Plays a sound, stops a playback, or mute/unmute the sound. (GT27, GT25 (excluding GT2505-V 

and GT25HS-V), GT SoftGOT2000, and GS25)

The setting items vary according to the selected action.
For the setting items for each action, refer to the following.

➟(1) [Momentary], [Set], [Reset], or [Alternate]
(2) [Data Set 8bit], [Data Set 16bit], [Data Set 32bit], or [Data Set 64bit]
(3) [Screen Switching]
(4) [Sound Output]

[Settings]
Set necessary items according to the item set for [Trigger Type].

➟6.2.2 Setting Trigger Types

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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(1) [Momentary], [Set], [Reset], or [Alternate]

1) [Points]
Set the number of devices operated when set conditions are satisfied.
The setting range is [1] to [40].

2) [Device Setting]
When setting 2 or more for [Points], select the method of setting devices.
The following shows selectable items.

• [Continuous]: Automatically inputs consecutive devices in the table of [Device] when a start device is set.
• [Random]: Sets devices one by one.

3) [Device]
Set the devices operated when set conditions are satisfied.
In the [Device] columns in the table, set the devices operated when set conditions are satisfied.
The [Indirect] columns are not used.

(2) [Data Set 8bit], [Data Set 16bit], [Data Set 32bit], or [Data Set 64bit]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

3)

1)
2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)
3)
4)

6)

5)
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1) [Points]
Set the number of devices to which values are written when set conditions are satisfied.
The setting range is [1] to [20].

2) [Data]
Select the data type of a value to be written to the target word device.
The selectable items vary according to the selection for [Action].

3) [Device Setting]
When setting 2 or more for [Points], select the method of setting devices.
The following shows selectable items.

• [Continuous]: Sets consecutive devices starting from a set device.
• [Random]: Sets devices one by one.

4) [Indirect]
Writes the value of an indirect word device to a target word device when the set condition is satisfied.
When setting 2 or more for [Points], select the method of setting indirect devices.
The following shows selectable items.

• [FMOV]: Set one indirect device.
➟9.5.3 ■2 (1) [Fixed] and [Indirect]

• [BMOV]: Set indirect devices one by one.
Select the method of setting indirect devices.
The following shows selectable items.
· [Continuous]: Sets consecutive devices starting from a set device.
· [Random]: Sets devices one by one.
➟9.5.3 ■2 (2) FMOV and BMOV

5) [Device]
Set the devices operated when set conditions are satisfied.
In the [Device] columns in the table, set word devices into which values are written when set conditions are satisfied.
In the [Indirect] columns in the table, set indirect devices.

➟6.1.2 How to set devices
6) [Fixed]

Set this item when writing a fixed value into the target word devices when set conditions are satisfied.
The setting range depends on the setting of [Data].

[Action] Selectable item

[Data Set 8bit]
[Signed BIN8]
[Unsigned BIN8]

[Data Set 16bit]
[Signed BIN16]
[Unsigned BIN16]
[BCD16]

[Data Set 32bit]

[Signed BIN32]
[Unsigned BIN32]
[BCD32]
[Real(32bit)]

[Data Set 64bit]

[Signed BIN64]
[Unsigned BIN64]
[BCD64]
[Real(64bit)]

[Data] Setting range

[Signed BIN8] -128 to 127

[Unsigned BIN8] 0 to 255

[Signed BIN16] -32768 to 32767

[Unsigned BIN16] 0 to 65535

[BCD16] 0 to 9999

[Signed BIN32] -2147483648 to 2147483647

[Unsigned BIN32] 0 to 4294967295

[BCD32] 0 to 99999999

[Real(32bit)] -999999000000.0 to 999999000000.0
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➟9.5.3 ■2 (1) [Fixed] and [Indirect]

(3) [Screen Switching]

1) [Screen Type]
Set the type of the destination screen.
The following shows selectable items.

• [Base]
• [Overlap Window1]
• [Overlap Window2]
• [Overlap Window3] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Overlap Window4] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Overlap Window5] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Superimpose Window1]
• [Superimpose Window2]
• [Dialog Window]

2) [Next Screen]
Set the destination screen for switching.
The following shows selectable items.

• [Fixed]
Select this item when switching to the screen that has given a specified screen No.

• [Back(Previous/History)]
Select this item when switching to the previously displayed screen.
The hierarchy mode or history mode is settable in the [Environmental Setting] window ([Screen Switching/
Window]).
➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

• [Device]
Select this item when specifying the destination screen No. with a set device value.

[Signed BIN64] -9223372036854775808 to 9223372036854775807

[Unsigned BIN64] 0 to 18446744073709551615

[BCD64] 0 to 9999999999999999

[Real(64bit)] -999999999999990000000.0 to 999999999999990000000.0

[Data] Setting range

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

When [Next Screen] is set to [Fixed]

When [Next Screen] is set to [Device]

4)
5)
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3) [Screen No.]
Set the destination screen number.
Click the [Browse] button to open the screen image.

4) [Data Type]
Select the data type of the device value.
The following shows selectable items.

• [Signed BIN16]
• [BCD16]

5) [Device]
Set a device.

➟6.1.2 How to set devices

(4) [Sound Output]

Not available to GT2505-V and GT25HS-V.

1) [Action Type]
Select an action of the sound output.
The following shows selectable items.

• [Play]
• [Stop]
• [Mute]

2) [Number of settings]
Total number of the play settings in the playlist.

3) [Add] button
Adds a new play setting to the playlist.

4) [Delete] button
Deletes a selected play setting in the playlist.

5) [Duplicate] button
Copies a selected play setting in the playlist.

6) [Up] button
Moves the cursor up one row in the playlist.

7) [Down] button
Moves the cursor down one row in the playlist.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

8)

2)

3) 4) 5) 6) 7)

10)
11)

12)

When [Action Type] is set to [Play]

When [Action Type] is set to [Stop]

When [Action Type] is set to [Mute]

13)

14)
9)
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8) Playlist
Lists the play settings of sound files.
Up to 16 play settings can be configured.
When the trigger condition is satisfied, the sound files specified in the playlist play continuously starting from the 
top of the list.

9) [Play] button
Plays the sound file that corresponds to a selected play setting in the playlist.

10) [Repeat] button
Plays the sound files specified in the playlist continuously, starting from the top of the list.
If [Specification] is set to [Device] in a play setting, the corresponding sound file is skipped.

11) [Stop] button
Stops the current playback.

12) [Edit] button
Displays the [Sound Setting] dialog.
Edit a selected play setting in the playlist.

➟9.5.7 [Sound Setting] dialog
13) [Detail Setting] (when [Action Type] is set to [Stop])

Select the behavior of the target action.
• [Stop currently playing sound]

Stops the current playback.
The standby sound file plays subsequently.

• [Stop all sound]
Stops the current playback and cancels all standby sound files.

14) [Detail Setting] (when [Action Type] is set to [Mute])
Select the behavior of the target action.

• [Mute]
• [Unmute]
• [Mute/unmute]

Item Description

[No.] Number of a play setting. The corresponding sound files play in order of increasing 
number.

[Specification]
Method of specifying a sound file.
• [File]: Uses a file number to specify a sound file.
• [Device]: Uses an indirect device to specify a sound file.

[File No./Device] Sound file number or the device to specify a sound file.
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9.5.7 [Sound Setting] dialog

Not available to GT2505-V and GT25HS-V.
Set a sound file to play when the trigger condition is satisfied.
To display this dialog, in the [Action] tab of the [Trigger/Action] dialog, set [Action] to [Sound Output] and [Action Type] to 
[Play], and then click the [Edit] button.

1) [File No.]
Select the method of specifying a sound file.
The following shows selectable items.

• [Fixed]
Uses a sound file number to specify a sound file.
After selecting this item, specify the file number of a registered sound file in the [Sound File List] dialog.
The setting range is [1] to [500].
Click the [Browse] button to display the [Sound File List] dialog.
Register or edit a sound file.
➟10.12.6 [Sound File List] dialog

• [Device]
Uses the value of a specified device to specify a sound file.
Select this item, and set a device.
➟6.1.2 How to set devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [File No.] is set to [Fixed]

When [File No.] is set to [Device]

1)
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9.6 Operating the Set Time as a Trigger ([Time Action])

9.6.1 Overview of the time action function

Devices can be turned on/off and write operations on values can be performed at a specified day of the week and time.
This function works based on a day of the week and time the GOT keeps.

■1 Turning on and off a bit device of a controller

■2 Writing a value into a word device of a controller

■3 Outputting sounds with an external speaker (GT27, GT25, GT SoftGOT2000, and GS25)

9.6.2 Specifications of the time action

■1 Number of time actions that can be set
Up to 32 settings can be configured for one project.

■2 Actions that can be executed when a set condition is satisfied
• Turning on/off bit devices
• Writing values into word devices
• Outputting sounds with an external speaker (GT27, GT25, GT SoftGOT2000, and GS25)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

→

Start Time

ON OFF

OFF ON

End Time

→

Start Time End Time

A set value is written. A set value is written.

0 100

Start Time End Time

A sound is output. A sound is output.

Operation
starts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.6 Operating the Set Time as a Trigger ([Time Action])

9 - 301



9.6.3 How to use the time action

■1 Setting procedure
The following shows the procedure for setting a time action.

Step 1 Select [Common] → [Time Action] from the menu.
The [Time Action List] dialog appears.
➟9.6.5 [Time Action List] dialog

Step 2 Select a row in the time action list and click the [Edit] button.
The [Time Action Attribute] dialog appears.
➟9.6.6 [Time Action Attribute] dialog

Step 3 In the [Time] tab, set the day of the week and time when the time action starts.

➟9.6.6 ■1 [Time] tab
Step 4 In the [Action] tab, set the action executed at the specified day of the week and time.

➟9.6.6 ■2 [Action] tab
Step 5 Click the [OK] button.

The [Time Action Attribute] dialog is closed.
Step 6 Click the [OK] button in the [Time Action List] dialog.

The dialog is closed and the registration of the time action is complete.

■2 Setting the start and end days of the week and time for time actions
When setting the days of the week and time when time actions start and end, select either of the following items.

(1) [Daily]
Select this item when setting the time when time actions start by day of the week.
The same action can be executed multiple times a week.
The start time and end time are required to be set in the same day.
Example) Writing a value into a word device at a specified time every day

(2) [Through]
Select this item when the start and end time straddle days.
An action can be executed only once a week.
The start and end time can be set on different days of the week.
Example) Turning on a specified bit device on Monday morning and turning off on Friday morning

When selecting [Through] for [Mode] and executing the same action twice or more a week, register the time 
action the number of times that the action is executed.
Example) Setting the same action executed twice a week
• Turing on M0 at a specified time on Monday AM, and turning off M0 at a specified time on Tuesday PM. 

(the setting of the first action)
• Executing no action on Wednesday
• Turing on M0 at a specified time on Thursday AM, and turning off M0 at a specified time on Friday PM. 

(the setting of the second action)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

10:00

100 is written into D10.

D10
100

D10
200

15:00

200 is written into D10.

Monday: Morning

M10 is turned on.

M10 M10

Friday: Night

M10 is turned off.
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■3 Controlling time actions
Time actions can be controlled with devices.
The settings of time actions can be output and changed.
The following shows the procedure for setting an external control.

Step 1 Select [Common] → [Time Action] from the menu.
The [Time Action List] dialog appears.
➟9.6.5 [Time Action List] dialog

Step 2 Select [Enable External Control] and set a device.

➟6.1.2 How to set devices
Step 3 When selecting [Separate] for [Device Setting], set an external control device for each time action.

Select a row in the time action list and click the [Edit] button.
The [Time Action Attribute] dialog appears.
➟9.6.6 [Time Action Attribute] dialog

Step 4 Select [External Control Device (8 Points)] in the [Time] tab and set a device.

➟9.6.6 ■1 [Time] tab

(1) External control devices
The settings of a time action can be stored in external control devices.
The setting items assigned to the devices depend on the selection for [Device Setting] in the [Time Action List] dialog.
When [Separate] is selected, the following devices are specified as external control devices.
• Three separate devices set in [External Control] in the [Time Action List] dialog
• Eight consecutive devices set for [External Control Device (8 Points)] in the [Time Action Attribute] dialog
If the device value for the day of the week when the time action starts and ends is 0, the setting of the time action is 
disabled.

Monday Tuesday Wednesday Thursday Friday

M0 is 
turned on.

M0 is 
turned off.

M0 is 
turned on.

M0 is 
turned off.

Item
Device

Description
[Separate] [Continuous]

Setting No. device Set device*1 Set device*1 Refer to the following.
➟(2) [Setting No. Device]

External control signal device Set device*1 Set device + 1*1
Refer to the following.

➟(3) [External Control Signal 
Device]

External control status 
notification device Set device*1 Set device + 2*1

Refer to the following.
➟(4) [External Control Status 

Notification Device]

Mode Set device*1 Set device + 3*1
Indicates [Mode] of the time action.
• b0: 0 [Daily], 1 [Through]
• b2 to b15: Use prohibited
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*1 Devices set in [External Control] in the [Time Action List] dialog

➟9.6.5 [Time Action List] dialog
*2 Devices set for [External Control Device (8 Points)] in the [Time Action Attribute] dialog

➟9.6.6 ■1 [Time] tab

(2) [Setting No. Device]
Store the setting No. (1 to 32) assigned to the target time action for the external control.

(3) [External Control Signal Device]
Executes an external control.
Turn on the bit corresponding to the required operation.
If multiple bits are turned on, the rightmost is prioritized.

• b0: Output trigger
Outputs the data of the time action to the external control devices.

• b1: Change trigger
Changes the settings of the time action to those of the external control devices.

• b2: Use prohibited
• b3: Time action setting file storage trigger

Saves the time settings of all the time actions as the time action setting file.
• b4: Time action setting file deletion trigger

Deletes the time action setting file.
• b5 to b15: Use prohibited

GOT's operations related to the time action setting file
When there is the time action setting file in the GOT at power on or reset, the GOT reads the time action 
settings from the time action setting file.

Start day of the week, end day of 
the week Set device + 1*2 Set device + 4*1

Indicates the days of the week when the time action 
starts and ends.
When selecting [Daily] for [Mode] of the time action, do 
not use the device for the end day of the week.
Start day of the week
• b0: Sunday
• b1: Monday
• b2: Tuesday
• b3: Wednesday
• b4: Thursday
• b5: Friday
• b6: Saturday
• b7: Use prohibited
End day of the week
• b8: Sunday
• b9: Monday
• b10: Tuesday
• b11: Wednesday
• b12: Thursday
• b13: Friday
• b14: Saturday
• b15: Use prohibited

Start time (hour) Set device + 2*2 Set device + 5*1

Indicates the time when the time action starts.
(Data type: BCD)Start time (minute) Set device + 3*2 Set device + 6*1

Start time (second) Set device + 4*2 Set device + 7*1

End Time (hour) Set device + 5*2 Set device + 8*1

Indicates the time when the time action ends.
(Data type: BCD)End Time (minute) Set device + 6*2 Set device + 9*1

End Time (second) Set device + 7*2 Set device + 10*1

Item
Device

Description
[Separate] [Continuous]
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(4) [External Control Status Notification Device]
Notifies the result of the execution of the external control.
After the completion of output or change, this device turns off automatically when the external control signal device is 
turned off.

• b0: Data were successfully output.
• b1: Data were successfully changed.
• b2: Error

A system error occurs.
• b3: The time action setting file was successfully saved. 

Turns on when the time action setting file is successfully saved.
• b4: The time action setting file was successfully deleted. 

Turns on when the time action setting file is successfully deleted.
• b5: The time action setting file was successfully read. 

Turns on when the time action setting file in the GOT is successfully read out.
• b6 to b15: Use prohibited

Disabling the time action setting file
To disable the read operation for reading from the time action setting file, perform either of the following 
operations then restart the GOT.

• Turn on b4 (time action setting file deletion trigger) of the external control device.
• Write the project in which it has become invalid to write the time action setting file to the GOT.

(5) Examples of operations in external control
(a) Output (outputting the settings of a time action to external devices)

Step 1 Set the setting No. assigned to the target time action for the change of settings.
Step 2 Turn on b0 of the external control signal device.
Step 3 The data of the time action are output to the external control devices.

(b) Change (changing the settings of the time action to those of the external devices)

Step 1 Set the setting No. assigned to the target time action for the change of settings.
Step 2 To the external control devices, write the values to replace with.
Step 3 Turn on b1 of the external control signal device.
Step 4 The time action is set with the values set above.

Time action attribute Setting No.

External control signal device
External control devices 
(8 points) for each time 
action attribute

Setting No. 1

External control signal device

External control devices 
(8 points) for each time 
action attribute

Time action attribute
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9.6.4 Precautions

■1 When using the same device for multiple time actions
When using the same device for multiple time actions, do not make the executions overlap.

■2 When using external control devices
When the following operations are performed after the settings of a time action is changed with external control devices, the 
settings are reset to the original ones set with GT Designer3.
• Transferring package data
• Installing BootOS
• Powering off and restarting the GOT

■3 Operations of time actions
If the GOT's internal clock or the status of the set device is changed, the execution of time actions may be affected.
The following lists the operations that affect time actions.

(1) Turning on a set bit device before a specified time
Time actions do not start at the specified time.
Example) When the set time when M0 turns on is 9:00

(2) When the GOT's internal clock is moved ahead/back
When the specified time when the action starts comes, the action starts.
However, if the current time, obtained after the clock has gone forward/back, is ahead of the specified time, the action 
does not start.
The following lists the operations that move the GOT's internal clock ahead/back.
• When moving ahead/back the GOT's internal clock with the utility [Time setting] (by the time notification)
• When the time of the controller is moved ahead/back (by the time setting)
• When the clock is moved ahead/back with the GOT internal devices (GS513 to GS516).
Example) To D0, 100 is written at the start time 8:00 and 200 is written at the end time 17:00.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

8:00 9:00 10:00 11:00 12:00 13:00

ON

OFF

OFFON

Status of M0 device

Operation set for the time action

100 is written into D0.

The time of the GOT's clock 
is changed from 10:00 to 7:00.

The time of the GOT's clock 
is changed from 10:00 to 20:00.

7:00 8:00 9:00 10:00 8:00 9:00
↓

7:00

10:00 21:00
↓

20:00

100 is written into D0.
200 is not written into D0 
because 17:00 does not come.
9 - 306 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.6 Operating the Set Time as a Trigger ([Time Action])



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

9.6.5 [Time Action List] dialog

By time actions, devices can be turned on/off and write operations on values can be performed at a specified day of the 
week and time.
Select [Common] → [Time Action] from the menu to display the [Time Action List] dialog.
Set the operations of time actions, start time, and end time.

1) Time action list
Lists set time actions.

➟9.6.6 [Time Action Attribute] dialog

2) [Edit] button
Changes the settings of a selected time action.

3) [Enable External Control]
Set this item when controlling time actions with devices.

4) [External Control]

Item Description

[No.] Displays the numbers that show the number of time actions.

[Action] Displays the actions executed when a set conditions is satisfied.

[Start Time] Displays the time when the time action starts.

[End Time] Displays the time when the time action ends.

[Day] Displays the day of the week when the time action is executed.

[Mode] Displays the mode in which the day of the week and time when the time action starts are 
specified.

[External Control] Displays a set external control device.

Item Description

[Edit] button
Changes the settings of a selected time action.

➟9.6.6 [Time Action Attribute] dialog

[Delete] button Deletes a selected time action.

[Delete All] button Deletes all the set time actions.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)

4)
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Set each item of an external control.

Item Description

[Device Setting]

Select the manner in which external control devices are set.
The following shows selectable items.
• [Separate]:

Set external control devices by time action.
Eight word devices are required per time action.

• [Setting No. Device]
Set a device that specifies the time actions to be controlled.

• [External Control Signal Device]
Set a trigger device that executes the control.
➟9.6.3 ■3 (3) [External Control Signal Device]

• [External Control Status Notification Device]
Set a device that outputs the status of the time action.
➟9.6.3 ■3 (4) [External Control Status Notification Device]

• [Continuous]:
Uses the same external control devices for all the set time actions.
Eleven word devices are required.

• [Setting No. Device(11 points)]
Set a device that specifies the time actions to be controlled.
Eleven consecutive devices counted from the specified device are set as external control 
devices.

[Enable the save to GOT]

Set this item when it is necessary to save the time action setting file in the GOT.
Setting this item enables b3 to b4 of the external control signal device and b3 to b5 of the 
external control status notification device.
Setting this item enables the following operations.
• Changing the settings of time actions with external control devices
• Deleting the time action setting file

➟9.6.3 ■3 (4) [External Control Status Notification Device]

[Destination Setting] button

Displays the [Destination Setting] dialog.
Set items required to save the time action setting file in the GOT.

• [Save to]
Set a destination drive.
The following shows selectable items.
· [A:Standard SD Card]
· [B:USB Drive]
· [C:Built-in Flash Memory]
· [D:Built-in SRAM]
· [E:USB Drive]
· [F:USB Drive]
· [G:USB Drive]
· [X:Current Drive]
For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

• [Folder Name]
Set the folder name of the folder where the file is stored.
For the restrictions on the folder name used with the GOT, refer to the following.
➟12.7 Restrictions for Folder Names and File Names used in GOT
When [C:Built-in Flash Memory] or [D:Built-in SRAM] is selected for [Save to], the name 
set in [Package Folder Name] in the [Type Setting] dialog is specified as the folder name.

• [File Name]
Set the name of the files to be saved.
For the restrictions of the file name used in the GOT, refer to the following.
➟12.7 Restrictions for Folder Names and File Names used in GOT
When [C:Built-in Flash Memory] or [D:Built-in SRAM] is selected for [Save to], 
"TIMEACTION" is specified as the file name.
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9.6.6 [Time Action Attribute] dialog

Click the [Edit] button in the [Time Action List] dialog to display the [Time Action Attribute] dialog.
➟■1 [Time] tab
■2 [Action] tab

■1 [Time] tab

Set the day of the week and time when the time action starts.

1) [Mode]
Set the mode in which the day of the week and time when the time action starts are specified.
The following shows selectable items.

• [Daily]: Executes the time action on a specified day of the week.
• [Through]: Enables the time action for the period between specified days of the week.

2) [Start]
Set the day of the week and time when the time actions starts.

3) [End]
Set the day of the week and time when the time action ends.

4) [External Control Device (8 Points)]
Set a device that controls the time action.

➟6.1.2 How to set devices
Eight consecutive devices counted from the specified device are set as external control devices.
Set this item when selecting [Separate] for [Device] in [Time Action List].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Hrs], [Min], [Sec] Set the time when the time actions starts.

[Day]
When selecting [Daily] for [Mode], set the day of the week when the time action starts.
Multiple days of the week can be selected.
When selecting [Through] for [Mode], set the day of the week when the time action starts.

Item Description

[Hrs], [Min], [Sec] Set the time when the time action ends.

[Day] Set the day of the week when the time action ends.
Set this item when selecting [Through] for [Mode].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

4)

2)
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■2 [Action] tab

Set the action to execute.

1) [Bit]
Set this item to turn on a bit device at the start of the time action and to turn off at the end of the action.
Set a bit device.

➟6.1.2 How to set devices
2) [Word]

Set this item to write values to a word device at the start and end of the time action.
Set a word device.

➟6.1.2 How to set devices

3) [Sound]
Available to GT27, GT25 (excluding GT2505-V and GT25HS-V), GT SoftGOT2000, and GS25.
Set this item to replay a sound at the start and end of the time action.

➟10.12 Outputting Sound with the GOT (Sound Output Function)

Item Description

[Data Type]

Set the data type of the word device.
The following shows selectable items.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [Signed BIN8]
• [Unsigned BIN8]
• [BCD 16]
• [BCD 32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

[Start Write Value], [End Write Value]
Set values to write to the word device at the start and end of the time action.
The setting range depends on the setting of [Data Type].

Item Description

[Start], [End]

Set the numbers assigned to the sound files output at the start and end of the time action.
The setting range is [1] to [500].
If the [Browse] button is clicked, a sound can be selected from the list.

➟10.12.6 [Sound File List] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)
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9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard 
Copy])

9.7.1 Overview of the hard copy function

The hard copy function captures the GOT screen image, and saves the image to a data storage or file server as an image 
file or PDF file.
The function can also print the captured image from a printer. 
The monitor screen displayed on the GOT can be captured as it is. 
Capturing only a specified base screen or overlap window from the displayed screens is also possible.
Even if displayed screens overlap one another, a target screen only can be captured.
A screen not displayed on the GOT screen can also be captured. 
This allows you to capture a different screen while displaying the operation screen on the GOT.

The screen image outputted by the hard copy function can be used for creating an operating instruction manual or for 
troubleshooting.

For a PDF file output, a function that saves multiple screen images to a single PDF file is available, eliminating the need to 
combine the images as a document.
However, the numbers of the output target screens must be consecutive. Design screens considering that requirement.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer 
(Edit)

GOT

The saved file is usable in 
various documents.

Saving as a file
• BMP file
• JPEG file
• PDF file

ラインA生産状況Line A status

How to operate 
screens

Printer

Line A status

Data storage 
or file server

Printing the image of the 
output target screen

Line A status
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9.7.2 Specifications of the hard copy

■1 Number of hard copies that can be set
One hard copy setting is available for one project.

■2 Hard copy execution
Execute a hard copy using either of the following functions. 

• Start trigger device
• Special function switch

■3 Specification of an output destination
Specify one of the following as the output destination of a captured screen image.
• File
• File + printer
• Printer
For specification of the output destination, refer to the following.

➟9.7.6 [Hard Copy] dialog

■4 Specification of an output target screen
Except for GT27, GT25, and GS25, an output target screen is fixed to the monitor screen displayed on the GOT and cannot 
be changed.
For GT27, GT25, and GS25, not only the monitor screen but also a base screen or overlap screen only out of the displayed 
screens can be specified for the output target screen.
A screen not displayed on the GOT (hereafter "hidden") can also be specified.
Specify one output target screen for each output destination (file, printer).
The following shows the selectable output target screens.

*1 The specified one overlap window is used as the resource for hard copy processing.
The specified overlap window cannot be displayed on the GOT screen and cannot be used as the target screen for hard copy.
To specify a resource overlap window, select [Take a hard copy of a screen other than the displayed monitor screen] in the 
[Environmental Setting] window ([Screen Switching/Window] tab).
➟5.2.1 ■5 [Screen Switching/Window]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Output target screen Resource 
securement*1 Explanation

Display status on the GOT Screen type

Displayed Monitor screen Not required The screen displayed on the GOT is captured as-is.

Base screen Required

Only a base screen or specified overlap window out of the screens 
displayed on the GOT is captured.

Overlap window 1

Overlap window 2

Overlap window 3

Overlap window 4

Overlap window 5

Hidden Base screen Required Capture the hidden base screen or window screen image by specifying 
the screen number.

• Hard copy execution delay setting
For capturing of a hidden screen image, the GOT starts monitoring of the 
target screen when the start trigger condition is satisfied.
Therefore, a wait time (delay) during which communication and drawing 
will complete needs to be set.
The one second of wait time set by default is insufficient for 
communication and drawing to complete depending on the screen 
design.
In this case, adjust the wait time by using GS526.
For details, refer to the following.

➟12.1.3 ■5 (63) Delay Hard Copy Execution (GS526)

Window screen
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Set an output target screen by specifying a fixed value in the [Hard Copy] dialog or using a device.
Using a device enables change of the output target screen dynamically.
For details, refer to the following.

➟9.7.6 [Hard Copy] dialog

Depending on the output target screen, the hard copy function does not support printer output.
A printer output to an unsupported printer is not executed and system alarm 366 is output.
The following shows the support statuses.
○: Supported , ×: Unsupported

■5 Checking the number of outputted screen images
The number of outputted screen images can be obtained by using GS693.
When outputting multiple screen images to a single PDF file, you can use this setting for checking the output progress.
For details, refer to the following.

➟12.1.3 ■3 (20) Notify Number of Hard Copy Output Screens signal (GS693)
To check the output progress rate, calculate the rate from the value set in [Number of screens] - [Fixed] in the [Hard Copy] 
dialog or the value stored in the device set in [Number of screens].

■6 Specifying a file format
Specify one of the following file formats for an output to a file.
• BMP file
• JPEG file
• PDF file (GT27, GT25, GS25)

Set a file format by specifying a fixed value in the [Hard Copy] dialog or using a device.
Using a device enables change of the output file format dynamically.
For details, refer to the following.

➟9.7.6 ■1 [File] tab

■7 Specifications for image file (BMP, JPEG) save
(1) Maximum number of files to be saved

One screen image is saved to one file and up to 9999 files can be saved.

(2) File name
A file name consists of the file name specified in GT Designer3 and file number.
Example) When [File Name] is set to [SNAP], and [Style] is set to [BMP]

■8 Specifications for PDF file save
(1) Maximum number of files to be saved

Up to 9999 files can be saved.
Saving multiple captured screen images to a single PDF file is available by specifying the number of screen images to 
be output.

Output target screen
Serial printer USB printer 

(PictBridge)
Network printer

(ESC/P-R, PCL5)Display status on the 
GOT

Screen type

Displayed Monitor screen ○ ○ ○

Base screen ○ ○ ○

Overlap window 1 to 5 × × ○

Hidden Base screen ○ ○ ○

Window screen × × ○

Order in which image files are saved File name

1st SNAP0001.BMP

2nd SNAP0002.BMP

: :

9998th SNAP9998.BMP

9999th SNAP9999.BMP
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(2) File name
The specifications are the same as those of image files.

➟■7 Specifications for image file (BMP, JPEG) save

(3) System application (extended function)
To save a captured screen image as a PDF file, [Hard Copy PDF Output] in a system application (extended function) is 
required.
Configuring either of the following settings incorporates the application into the package data automatically.

• In the [Hard Copy] dialog ([File] tab), select [Fixed]-[PDF] for [Style].
• In the [Hard Copy] dialog ([File] tab), select [Output PDF file].

(4) Specifications of the page size and orientation
Specify the page size and orientation of the PDF file.
For details, refer to the following.

➟9.7.6 ■1 [File] tab

■9 Specifications of the printer output
On GT SoftGOT2000, the captured screen images are output to the printer connected with the personal computer.
For the specifications of the hard copy function on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(1) Usable printers
The following printers are supported.

• PictBridge-compatible printer (GT27 and GT25 (excluding GT25-W, GT2505-V, and GT25HS-V))
• Serial printer (GT27, GT25 except GT25HS-V, GT23, GT21, GS25, and GS21)
• Ethernet printer (GT27, GT25, GT23, GT21 except GT2105-Q, GS25, and GS21)

(2) System application (extended function)
The following system application (extended function) is required.

• For PictBridge-compatible printers: [Printer(PictBridge)]
• For serial printers: [Printer(Serial)]
• For Ethernet printers (ESC/P-R): [Printer(ESC/P-R)]
• For Ethernet printers (PCL5): [Printer(PCL5)]

Selecting [Printer] for [Destination] in the [Hard Copy] dialog incorporates the application into the package data 
automatically.
To use the function on GT21, GT SoftGOT2000, or GS21, the application is not required.

(3) Required version of BootOS
To use an Ethernet printer (ESC/P-R), install version AJ or later of BootOS on the GOT.

➟4.3.2 Transferring data
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9.7.3 How to use the hard copy function (File save)

■1 Setting procedure
The following shows the procedure for outputting a captured screen image to a file.

Step 1 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 2 Set [Destination] to [File] or [File + Printer].
Step 3 In the [File] tab, set necessary items and click the [OK] button.

➟9.7.6 ■1 [File] tab
When [File + Printer] is selected for [Destination], configure the setting for the printer output as well.
➟9.7.4 How to use the hard copy function (Printer output)

For the methods of starting a hard copy output, refer to the following.
➟9.7.3 ■2 Starting a hard copy output

■2 Starting a hard copy output
The following shows the procedure for starting a hard copy output.

(1) Using a start trigger device
Set the start trigger device for a file save.

Step 1 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 2 In the [File] tab, select [Start Trigger Device].
Step 3 Specify a start trigger device, and click the [OK] button.

To start a hard copy output, use a bit switch or other methods to turn on the start trigger device.
Set the ON and OFF times of the start trigger device to one second or more for each.
If you use the bit switch in which [Action] is set to [Momentary], configure the settings in the [Bit Switch] dialog ([Extended] 
tab) as shown below.

• Set [Delay] to [OFF].
• Set [Delay Time] to [1] second or more.

➟8.2.5 [Bit Switch] dialog

(2) Using a special function switch
Configure the settings of a special function switch as shown below.

• Set [Switch Action] to [Start Hard Copy].
• Select [Specify the destination to output hard copies].
• Set [Destination] to [File].

Setting a start trigger device is unnecessary.
To start a hard copy output, touch the set special function switch.

➟8.2.9 [Special Function Switch] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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9.7.4 How to use the hard copy function (Printer output)

Not available to GT25HS-V.

■1 System configuration
The following shows the system configuration when a printer is used.
For connecting a printer to the GOT, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

On GT SoftGOT2000, the captured screen images are output to the printer connected with the personal computer.
For the specifications of the hard copy function on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(1) PictBridge-compatible printer

*1 The unit for the communication between the GOT and the PictBridge-compatible printer.
Some PictBridge-compatible printers may not be able to print data properly. For the precautions of the printer connection, refer 
to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)

*2 GT25-W, GT2505-V, and GT25HS-V are excluded.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Printer Connection cable GOT
PLC

Number of 
connectable 

printersModel Model Option GOT 
model

For the connectable printers and 
system devices, refer to the following 
Technical News.

➟List of Valid Devices Applicable 
for GOT2000 Series and GOT 
SIMPLE Series (for Overseas) 
(GOT-A-0160)

GT09-C30USB-5P(3m)
(included in the printer unit) GT15-PRN*1

GT27

GT25*2

For the system 
configuration between 
the GOT and the PLC, 
refer to each connection 
manual.

One printer for 
one GOT

PLCGOT
PictBridge-
compatible 

printer
Connection cable

Available cables differ depending 
on the connection type.
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(2) Serial printer

*1 Available RS-232 cables differ according to the printer used. Prepare a RS-232 cable that is suitable for the specifications of 
the printer to be used.

*2 GT25HS-V is excluded.

(3) Ethernet printer

Printer Connection 
cable GOT

PLC
Number of 

connectable 
printersModel Model Option GOT 

model

For the connectable printers and system devices, refer 
to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 
Series and GOT SIMPLE Series (for Overseas) 
(GOT-A-0160)

RS-232 
cable *1

- (Built into GOT)

GT27

GT25 *2

GT23
GT21
GS25
GS21

For the system 
configuration between 
the GOT and the PLC, 
refer to each connection 
manual.

One printer for 
one GOT

Connection cable

GOT PLC

Available cables differ depending 
on the connection type.

Serial 
printer

Printer Connection cable *1*2,
wireless LAN access point

Maximum 
segment 
length *3

GOT

PLC

Number of 
connectable 

personal 
computersOption GOT 

model

Select by each user
➟List of Valid Devices 

Applicable for GOT2000 
Series and GOT SIMPLE 
Series (for Overseas) 
(GOT-A-0160)

• 100BASE-TX
Shielded twisted pair cable (STP) 
or unshielded twisted pair cable 
(UTP) of category 5 or higher

• 10BASE-T
Shielded twisted pair cable (STP) 
or unshielded twisted pair cable 
(UTP) of category 3 or higher

100m

- (Built into GOT)

GT27

GT25 *8

GT23

GT21 *9

GS25
GS21

For the system 
configuration 
between the 
GOT and the 
PLC, refer to 
each connection 
manual.

One personal 
computer for 
one GOT

GT25-J71E71-100
GT27
GT25 *6

- - GT25-WLAN
GT27 *4

GT25 *4*7

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN 
access points and system 
devices, refer to the following 
Technical News.
➟List of Valid Devices 

Applicable for GOT2000 
Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-
0160)

- GT25-WLAN
GT27 *5

GT25 *5*7

GS25 *5

The system configuration between GOT and PLC 
depends on the connection type.

Ethernet printer GOT PLC

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
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*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 When a hub is used, use a straight cable.
To connect the GOT and the printer directly with an Ethernet cable, use a straight or cross cable.
For the cables usable for your printer, check the printer specifications.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 personal computers for a cascade connection (500m)
• 100BASE-TX: Up to 2 personal computers for a cascade connection (205m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 GT25-W, GT2505-V, and GT25HS-V are excluded.
*7 GT2505-V and GT25HS-V are excluded.
*8 For GT2505HS-V, one built-in interface is usable.

An Ethernet printer is connectable only when the GOT is connected to a controller by Ethernet.
*9 GT2105-Q is excluded.

■2 Setting procedure
The following shows the procedure for outputting captured screen image to a printer.

(1) For GT27, GT25, GT23, GT21, GS25, and GS21
The following shows the procedure for outputting a captured image to a printer.

Step 1 Connect a printer to the GOT.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

Step 2 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 3 Set [Destination] to [Printer] or [File + Printer].
Step 4 In the [Printer] tab, set necessary items and click the [OK] button.

➟9.7.6 ■2 [Printer] tab
When [File + Printer] is selected for [Destination], configure the setting for the image file output as well.
➟9.7.3 How to use the hard copy function (File save)

For the methods of starting a hard copy output, refer to the following.
➟9.7.4 ■3 Starting a hard copy output

If you start a hard copy output while the printer is powered off, a captured screen image cannot be printed.
Make sure to power on the printer.
Printing starts upon power-on of the printer.

(2) For GT SoftGOT2000
The following shows the procedure for outputting a captured image to a printer.

Step 1 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 2 Set [Destination] to [Printer] or [File + Printer].
Step 3 In the [Printer] tab, set necessary items and click the [OK] button.

➟9.7.6 ■2 [Printer] tab
When [File + Printer] is selected for [Destination], configure the setting for the image file output as well.
➟9.7.3 How to use the hard copy function (File save)

Step 4 On GT SoftGOT2000, select the [Project] menu and configure the print settings.
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➟9.7.6 [Hard Copy] dialog

For the methods of starting a hard copy output, refer to the following.
➟9.7.4 ■3 Starting a hard copy output

If you start a hard copy output while the printer is powered off, a captured screen image cannot be printed.
Make sure to power on the printer.
Printing starts upon power-on of the printer.

■3 Starting a hard copy output
The following shows the procedure for starting a hard copy output.

(1) Using a start trigger device
Set the start trigger device for the printer output.

Step 1 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 2 In the [Printer] tab, select [Start Trigger Device].
Step 3 Specify a start trigger device, and click the [OK] button.

To start a hard copy output, use a bit switch or other methods to turn on the start trigger device.
Set the ON and OFF times of the start trigger device to one second or more for each.
If you use the bit switch in which [Action] is set to [Momentary], configure the settings in the [Bit Switch] dialog ([Extended] 
tab) as shown below.

• Set [Delay] to [OFF].
• Set [Delay Time] to [1] second or more.

➟8.2.5 [Bit Switch] dialog

(2) Using a special function switch
Configure the settings of a special function switch as shown below.

• Set [Switch Action] to [Start Hard Copy].
• Select [Specify the destination to output hard copies].
• Set [Destination] to [Printer].

Setting a start trigger device is unnecessary.
To start a hard copy output, touch the set special function switch.

➟8.2.9 [Special Function Switch] dialog

■4 Aborting a hard copy output
The following shows the procedure for aborting a hard copy output.
GT SoftGOT2000 does not support aborting a hard copy output.

(1) Using an abort trigger device
Set the abort trigger device for the printer output.

Step 1 Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

➟9.7.6 [Hard Copy] dialog
Step 2 In the [Printer] tab, select [Abort Trigger Device].
Step 3 Specify an abort trigger device, and click the [OK] button.

To abort a hard copy output, use a bit switch or other methods to turn on the abort trigger device.
Set the ON and OFF times of the abort trigger device to one second or more for each.
If you use the bit switch in which [Action] is set to [Momentary], configure the settings in the [Bit Switch] dialog ([Extended] 
tab) as shown below.

• Set [Delay] to [OFF].
• Set [Delay Time] to [1] second or more.

➟8.2.5 [Bit Switch] dialog
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(2) Using a special function switch
In the setting of a special function switch, set [Switch Action] to [Abort Hard Copy].
Setting an abort trigger device is unnecessary.
To abort a hard copy output, touch the set special function switch.

➟8.2.9 [Special Function Switch] dialog

■5 Printing a captured image with inverted black and white colors
A captured screen image is printable with inverted black and white colors.
The black and white areas are inverted.
Any other color areas (including gray and red) are printed as-is.

The black and white inversion is useful for the following purposes.
• To use less ink of the printer when a screen image to be printed has many black areas
• To improve visibility when a screen image to be printed has many black areas

The following shows how to enable or disable the black and white inversion.

(1) Configuring the setting on GT Designer3
To enable the black and white inversion, select [Invert] in the [Hard Copy] dialog ([Printer] tab).

➟9.7.6 [Hard Copy] dialog
This setting is not applied to GT SoftGOT2000.
Configure the print settings on GT SoftGOT2000.

➟GT SoftGOT2000 Version1 Operating Manual

(2) Using the system signals
To enable the black and white inversion on the GOT, use the following system signals.
Not available to GT SoftGOT2000.
• Hard Copy Setting Validate signal (System signal 1-1.b10)
Turning on this signal enables the setting change of the hard copy function.
Turn on the signal before executing a hard copy output.
Turn on this signal before the GOT recognizes its internal processing (it takes approximately 300 ms).

• Hard Copy White/Black Reverse signal (System signal 1-1.b12)
When this signal is on, the black and white inversion is enabled.
When this signal is off, the black and white inversion is disabled.

When [Invert] is not set When [Invert] is set

The areas whose colors are 
any color other than white and 
black are printed with the set colors.
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9.7.5 Precautions

■1 Precautions for use
(1) When using a file save and a printer output together

If the trigger condition for a printer output is satisfied while a file save is being executed, the printer output is executed 
upon completion of the file save.
If the trigger condition for a file save is satisfied while a printer output is being executed, the file save is executed upon 
completion of the printer output.
A screen image is captured not when a trigger condition is satisfied, but when processing is executed.
If the trigger condition for a file save and that for a printer output are satisfied simultaneously, the GOT captures the image 
of the screen displayed when each processing is executed.
Thus, the captured screen images may be different between the outputs.

Example) When the trigger condition for a printer output is satisfied while a file save is ongoing
Upon completion of the file save, the printer output is executed.

(2) Precautions when system alarm 340 occurs
If system alarm 340 occurs while a PictBridge-compatible printer or Ethernet printer (ESC/P-R) is used, saving images 
to a file is stopped and may not be executed.
To restart the file save, cancel the printer output in one of the following methods.
• Eliminate the cause of printer error
• Satisfy the abort trigger conditions
• Pressing the special function switch for which the action at aborted hard copy is set
• Turning on the Print Abort signal (System signal 1-2.b15)

(3) Utilizing a GOT1000 project
If you convert a GOT1000 project to a GOT2000 project, check the printer setting of the project.
When the output destination is set to a printer in a GOT1000 project, the destination interface for the printer is set to [Not 
connected] automatically in the printer setting.
After the project conversion, change the destination interface for the printer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Trigger for a hard copy (printer output)

File save process

OFF

ON

Trigger for a hard copy (file save) OFF

Printer output process

ON ON

Waiting to be 
processed

An image is captured when each output is executed.
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(4) Precautions on output target screens
Depending on the output target screen, different precautions are applied.
○: Applicable , ×: Not applicable

Category

Specified output target screen

PrecautionDisplayed Hidden

Monitor 
screen

Base 
screen

Overlap window 
1 to 5

Base 
screen

Window 
screen

Hard copy of an 
overlap window

- - ○ - -
When a specified overlap window is used as the system window 
or displayed on a different screen using the video output 
function, the hard copy is executed for that screen.

- - ○ - - If a specified overlap window is hidden, the hard copy is not 
executed and system alarm 365 is output.

- - ○ - -

If a window screen is created with the maximum screen size, the 
hard copy output is produced with the window frame cut off.
To include the window frame in the hard copy, set the screen 
size considering the frame area.

Hard copy of a 
screen other 
than the monitor 
screen

- ○ ○ ○ ○

If [Take a hard copy of a screen other than the displayed 
monitor screen] in the [Environmental Setting] window ([Screen 
Switching/Windows] tab) is not selected, the hard copy is not 
executed and system alarm 366 is output.

- ○ ○ ○ ○

The video/RGB display object is not available for hard copy 
output on screens other than the monitor screen.
When a hard copy output is executed, the object is not captured 
in the screenshot.

- - - ○ -
If a superimpose window is placed on the output target screen, 
the window will not be captured in the screenshot when a hard 
copy output is executed.

Screen transition 
during hard copy

- ○ ○ ○ ○
If a transition to a utility screen or extended system application 
screen occurs, the hard copy is not executed and system alarm 
366 is output.

- - - ○ ○
If a transition to a utility screen or extended system application 
screen occurs during hard copy of multiple screens, the hard 
copy is aborted and system alarm 366 is output.

- - - ○ ○
If the target screen is displayed due to screen switching during 
hard copy, the hard copy is aborted and system alarm 366 is 
output.

When the screen 
gesture function 
is used together

- ○ - - -
While the screen is zoomed or scrolled with the gesture 
function, the hard copy is not executed and system alarm 366 is 
output.

When the base 
screen size 
expansion is 
used together

- ○ - ○ -
When the base screen size expansion is set to the output target 
base screen, the hard copy is not executed and system alarm 
366 is output.
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■2 Precautions for use (only when using file save)
(1) GOT status during a hard copy

While a hard copy operation is being performed, the GOT interrupts its processing of screens being displayed.
The screen processing restarts after the completion of the hard copy.

(2) State of a new trigger while a file save is being executed
If the trigger condition for a file save is satisfied while another file save is being executed, the new trigger is invalid.

Make sure that the trigger condition for a new file save is satisfied after the ongoing file save is complete.
Check the Writing Notification device for completion of a file save.

➟9.7.6 ■1 [File] tab

(3) To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

(4) Precautions when outputting multiple screen images to a single PDF file
If the specified number of screens is outside the range, the hard copy is not executed and system alarm 367 is output.
If the size of memory used by the GOT to generate a PDF file exceeds the user area (20 MB), the hard copy output is 
not executed and system alarm 369 is output even though the specified number of screens is within the range.
If system alarm 369 is output, reduce the number of output target screens or take other actions.
• Even one of sequentially numbered screens out of the specified number of screens is missing
• When the security level is insufficient
• When the screen number of the currently displayed screen is included

■3 Precautions for use (Printer output only)
(1) Some areas of the screen on the GOT cannot be copied

Depending on the printer used, some areas of the screen may not be copied properly.
If it happens, disable the trimming in the setting of the printer used. (Some printers may not have the trimming setting.)

Quantity limit for 
the objects to be 
displayed

- - - ○ ○

Even when a hidden screen image is output, the quantity limit is 
applied to the objects on that screen.
The objects cannot be displayed if the quantity limit is 
exceeded.
The quantity limit is applied to the following objects to be 
displayed.
• Recipe display (record list)
• Document display
• System alarm display

When the following operations are performed, the system alarm 
303 is output.
• (Operation)

A hard copy output is executed when an object with quantity 
limit is placed on both the displayed screen and the output 
target screen.
(Result)
The hard copy output is executed, but the relevant object is not 
captured in the screenshot.

• (Operation)
While a hard copy output is being executed for the screen on 
which an object with quantity limit is placed, another screen 
with the relevant object is attempted to be displayed on the 
monitor screen.
(Result)
The screen is displayed on the monitor screen, but the 
relevant object is not displayed.

Category

Specified output target screen

PrecautionDisplayed Hidden

Monitor 
screen

Base 
screen

Overlap window 
1 to 5

Base 
screen

Window 
screen
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(2) Printer's error
When an error occurs in the printer at the printing or the printer fed a blank sheet of paper but it can print the data properly 
when the restart button is pressed, set [A4] for [Print Image Size] of the hard copy and supply A4-size papers into the 
printer in the portrait direction.
An error may occur depending on the printer used when the sheet size and print image size are different.
Even though you use the printer in which an error occurs when [Print Image Size] is set for any size other than [A4], it 
may print the data properly with the set size.
• Set any size other than [A4] to [Print Image Size] of the hard copy.
• Supply A4-size papers into the printer in the portrait direction.
• An error (such as the printer feeds a blank sheet of paper) may occur. However, the printer may be able to print data 
properly when the restart button is pressed.

For the details of the operations and settings of the printer, refer to the following.
➟Manual of the printer used

(3) State of a new trigger while a printer output is being executed
Even if the trigger condition for a printer output is satisfied while another printer output is being executed, the new trigger 
is invalid.
Make sure that the trigger condition for a new printer output is satisfied after the ongoing printer output is complete.
Check the Hard Copy Output signal (System signal 2-1.b7) for completion of a printer output.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■4 Precautions for using serial printers
In the following cases, a serial printer may not print data and a system alarm may not occur even if the Print Output signal 
(System signal 2-2.b15) is turned off.
• A printer is powered off.
• The cable of a printer is unplugged.

■5 Precautions for using Ethernet printers
(1) Precautions for printing

When a printing job is executed under the following conditions, the Printer Error Detection signal (System signal 2-1.b15) 
is turned on, and the job is canceled.
• A printer is disconnected.
• A printer is powered off.

For a PCL5 printer, the Printer Error Detection signal (System signal 2-1.b15) is not turned off automatically.
Fix the error and turn off the signal.

(2) Precautions when an error occurs in a printer
For a PCL5 printer, when an error occurs in a printer, the Printer Error Detection signal (System signal 2-1.b15) is not 
turned on.
Check the printer status and fix the error.
The printer pauses the printing and resumes the job when the error is fixed.

(3) Precautions for system alarms
For a PCL5 printer, even if the printer is powered off or the network is disconnected during printing, no system alarm may 
occur.

(4) Precautions when the Printer Error Detection signal (System signal 2-1.b15) is turned on
The data output to a printer when this signal is on is printed when the signal is turned off.
If the data is faulty, the data is deleted and the printing is canceled.
For a PCL5 printer, all printing jobs are canceled when this signal is on.
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■6 Precautions for using Ethernet printers (GT21 and GS21)
(1) Print size

A captured screen image is resized at printing as follows.

Model Screen size (dot) Print size

GT2107-W
GS21

800 × 480 135 × 81 mm

GT2104-R 480 × 272 81 × 46 mm

GT2104-P 384 × 128 130 × 43 mm

GT2103-P 320 × 128 109 × 43 mm
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9.7.6 [Hard Copy] dialog

Configure the hard copy settings.
Select [Common] → [Hard Copy] from the menu to display the [Hard Copy] dialog.

1) [Destination]
Outputs a captured screen image to a file.
The following shows selectable items.

• [File]
Outputs a captured image to an image file.
Displays the [File] tab.

• [Printer]
Outputs a captured image to a printer.
Displays the [Printer] tab.

• [File + Printer]
Outputs a captured screen image to a file or a printer.
Displays the [File] tab and the [Printer] tab.

For the setting items on each tab, refer to the following.
➟■1 [File] tab
■2 [Printer] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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■1 [File] tab

1) [Drive Name]
Set the destination drive.
The following shows selectable items.

• [A:Standard SD Card]
• [B:USB Drive]
• [E:USB Drive]
• [F:USB Drive]
• [G:USB Drive]
• [N:Network Drive]
• [X:Current Drive]

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

2) [Folder Name]
Set the name of the folder to which an image file is saved.
Up to 65 characters can be set.
When [1/2] or [1/4] is selected for [Thumbnail Output], up to 63 characters can be set.
For the restrictions on the folder name, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
3) [File Name]

Set the name of the files to be saved.
Up to 67 characters can be set.
When [1/2] or [1/4] is selected for [Thumbnail Output], up to 65 characters can be set.
For the restrictions on the file name, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT
4) [Separate destinations for each GOT]

Available to GT27, GT25, and GS25.
This item appears when [Drive Name] is set to [N:Network Drive].
Automatically creates a folder for each GOT to save files.
Each folder is named as the IP address of each GOT.

➟5.3.15 ■4 Creating a folder for each GOT

1)
2)
3)
4)

5)
6)
7)
8)
9)

10)
11)
12)

13)
14)
15)
16)
17)
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5) [Style]
PDF output is only available to GT27, GT25, and GS25.
Set the file format of a file to be saved.
Set this item by specifying a fixed value or using a device.

6) [Thumbnail Output]
When the output format is PDF, this item is not displayed because thumbnail output is not supported.
If the output target is as follows, this item is disabled even though it is set, and system alarm 359 is output at a file 
output.

• Displayed screen: Overlap windows 1 to 5
• Hidden screen: Base screen

Set this item to create a thumbnail of a captured image when the image is saved to a file.
Example) [1/2] in size

7) [Output PDF file]
This item is displayed when [Device] is selected for [Style].
Be sure to select this item to execute a PDF output using a device.

8) [Page Orientation]
Specify the PDF page orientation.
The screen is scaled to fit the page size.
Left, right, top, and bottom margins are provided on the page of the outputted PDF file.

Item Description

[Fixed]

Specify one of the following.
• [BMP]
• [JPEG]
• [PDF]

[Device]

Available to GT27, GT25, and GS25.
You can specify a word device or word-specified bit device (data type: unsigned 16-bit binary data).
The following shows the setting values.
• 0: BMP
• 1: JPEG
• 2: PDF
If a value other than the above is set, the hard copy is not executed and system alarm 367 is output.
To specify the PDF format, be sure to select [Output PDF file].

Item Description

[1/2]

Creates a thumbnail that is half of normal screen size.
The following shows the destination folder.
• Folder name: Folder set with [Folder Name]\M
• File name: Name set for [File Name]

[1/4]

Creates a thumbnail that is a quarter of normal screen size.
The following shows the destination folder.
• Folder name: Folder set with [Folder Name]\S
• File name: Name set for [File Name]
To use the vertically installed GT27-S or GT27-V, install the version E or later of BootOS on the GOT.

Item Description

[Vertical] Images are all vertically outputted regardless of the aspect ratio of the screen.

[Horizontal] Images are all horizontally outputted regardless of the aspect ratio of the screen.

[Automatic] The page orientation is automatically determined considering the aspect ratio of the output target screen so 
that the margins will be minimized.
[Vertical] is set for square and vertically oriented screens whereas [Horizontal] is set for horizontally oriented 
screens.

Normal screen size

Size of thumbnail output

1/2

1/2
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9) [Page Size]
Specify the PDF page size.

• [A4 (210x297mm]
• [Letter (8.5"x11")]

10) [Output Target]
Available to GT27, GT25, and GS25.
Except for GT27, GT25, and GS25, this item is not displayed because the setting is fixed to the monitor screen 
displayed on the GOT.
Specify an output target screen.
Set this item by specifying a fixed value or using a device.
To specify a screen other than the monitor screen being displayed, select [Common] → [GOT Environmental Setting] 
→ [Screen Switching/Windows] and specify a screen not selected for [Take a hard copy of a screen other than the 
displayed monitor screen].

11) [Screen No.]
Set this item when the output target is a hidden screen.
Specify the number of the screen whose image is to be output.
Set this item by specifying a fixed value or using a device.

12) [Number of screens]
Set this item when the output format is PDF and the output target is a hidden screen.
If the screen numbers are consecutive, specifying the number of screens enables output of multiple screen images to 
a PDF file.
Specify the number of screens to be output, counting from the screen number specified in [Screen No.].
Set this item by specifying a fixed value or using a device.

Item Description

[Fixed]

Specify one of the following.
• • [Displayed monitor screen]
• • [Displayed base screen]
• • [Displayed overlap window 1]
• • [Displayed overlap window 2]
• • [Displayed overlap window 3]
• • [Displayed overlap window 4]
• • [Displayed overlap window 5]
• • [Hidden base screen]
• • [Hidden window screen]

[Device]

You can specify a word device or word-specified bit device (data type: unsigned 16-bit binary data).
The following shows the setting values.
• 0: Displayed monitor screen
• 1: Displayed base screen
• 2: Displayed overlap window 1
• 3: Displayed overlap window 2
• 4: Displayed overlap window 3
• 5: Displayed overlap window 4
• 6: Displayed overlap window 5
• 7: Hidden base screen
• 8: Hidden window screen

Item Description

[Fixed]
Clicking the [Browse] button displays the [Screen Image List] dialog.
Check the screen image on the dialog before setting.

[Device]
You can specify a word device or word-specified bit device (data type: unsigned 16-bit binary data).
Set a value within the range from 0 to 32767.

Item Description

[Fixed] Set a value within the range from 1 to 100.

[Device]
You can specify a word device or word-specified bit device (data type: unsigned 16-bit binary data).
Set a value within the range from 1 to 100.
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13) [Delete the file with the smallest number and create another file when the capacity of the 
destination is exceeded]
Not available to GT SoftGOT2000.
Deletes an existing file and saves a new file when the save destination drive has insufficient free space.
Operation varies depending on the amount of free space of the destination drive and the file number of each file in the 
destination folder.

When the number of files in the destination folder reaches 9899, the System signal 2-1.b12 turns on.
If you deselect this item, a new file is not created when the destination drive has insufficient free space or file No. 9999 
exists in the destination folder.

14) [Start Trigger Device]
Set the device to start a hard copy (file save).
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
15) [Writing Notification Device]

Not available to GT SoftGOT2000.
Set the device to notify that a captured image is being saved to a file.
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
This device is on during an image file output.

16) [Writing Error Notification Device]
Not available to GT SoftGOT2000.
Set the device to notify that saving a captured image to a file has failed.
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
This device turns on when an error occurs during an image file output.
The device does not turn off automatically even after error recovery.
You need to turn off the device.

17) [File No. External Control Device]
Set the device that specifies the file number of a file to be saved.
The data type of the device is unsigned 16-bit binary.
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
The valid range of the file number is 1 to 9999.
If a specified file number exists, the corresponding file is overwritten.
If a specified file number is outside the valid range, the file is not saved.
This setting overrides the setting of [Delete the file with the smallest number and create another file when the capacity 
of the destination is exceeded]. (The GOT performs the operation with the latter item deselected.)

File number of a file in 
the destination folder If the destination drive has enough free space If the destination drive has insufficient free space

File No. 9999 
nonexistent

A new file is saved with the largest file number in the 
destination folder.

The existing files are deleted, starting from the one 
with the smallest file number in the destination folder, 
until a new file is saved.
A new file is saved with the largest file number in the 
destination folder.

File No. 9999 existent All existing files in the destination folder are deleted, and a new file is saved with file No. 1.
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■2 [Printer] tab
Not available to GT25HS-V.

1) [Printer Type]
Not available to GT SoftGOT2000.
Type of a selected printer.
To select a printer type, click the [Printer Setting] button.

➟10.11.8 [Printer] dialog
2) [Color Mode]

Not available to GT SoftGOT2000.
When [Printer Type] is set to [ESC/P-R]
The following shows selectable items.

• [Color]
• [Monochrome]

3) [Invert]
Prints a captured screen image with inverted black and white colors.
For the black and white inversion, refer to the following.

➟9.7.4 ■5 Printing a captured image with inverted black and white colors
This setting is not applied to GT SoftGOT2000.
Configure the print settings on GT SoftGOT2000.

➟GT SoftGOT2000 Version1 Operating Manual
4) [Page break after printing]

Not available to GT SoftGOT2000.
This item can be set only when [Serial] is selected for [Printer Type].
Set the number of screens to print without page break.
The setting range is [1] to [4]

2)

5)

6)
7)

8)
9)

1)
4)

When [Printer Type] is set to [ESC/P-R]

When [Printer Type] is set to [Serial]
3)
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.7 Capturing the GOT Screen and Outputting the Screen Image ([Hard Copy])

9 - 331



5) [Print Image Size]
This item is settable when [Printer Type] is set to [PictBridge], [ESC/P-R], or [PCL5].
The selectable items vary according to the selection for [Printer Type].

○ : Available, ×: Not available

This setting is not applied to GT SoftGOT2000.
Configure the print settings on GT SoftGOT2000.

➟GT SoftGOT2000 Version1 Operating Manual
6) [Output Target]

Equivalent to the file output settings.
For details, refer to the following.

➟■1 [File] tab
7) [Screen No.]

Equivalent to the file output settings.
For details, refer to the following.

➟■1 [File] tab
8) [Start Trigger Device]

Set the device to start a printer output.
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
9) [Abort Trigger Device]

Set the device to abort a printer output.
For the setting procedure, refer to the following.

➟6.1.2 How to set devices
This setting is not applied to GT SoftGOT2000.

[Printer Type]
[Print Image Size]

[L(89x127mm)] [Postcard(100x148
mm)] [2L(127x178mm)] [A4(210x297mm)] [Letter (8.5"x11")]

[PictBridge] ○ ○ ○ ○ ×

[ESC/P-R] ○ ○ ○ ○ ○

[PCL5] × × × ○ ○
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9.7.7 Relevant settings

Set the relevant settings other than the specific settings for the hard copy as required.
The following shows the functions that are available by the relevant settings.

■1 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Enabling the reverse printing of the hard copy function with the system signal. (Read device: System 
signal 1-1.b10)

[System Signal 1-1]
(Not available to GT SoftGOT2000)

Specifying the invert printing of the hard copy. (Read device: System signal 1-1.b12)
[System Signal 1-1]
(Not available to GT SoftGOT2000)

Notifying that data is being output to a file or printer. (Write device: System signal 2-1.b7)
[System Signal 2-1]
(Not available to GT SoftGOT2000)

Aborting the printing process. (Read device: System signal 1-2.b15)
[System Signal 1-2]
(Not available to GT SoftGOT2000)

Notifying an error of printer while the printing process is being executed. (Write device: System signal 2-
1.b15)

[System Signal 2-1]
(Not available to GT SoftGOT2000)

Notifying that the printing process is being executed. (Write device: System signal 2-2.b15)
[System Signal 2-2]
(Not available to GT SoftGOT2000)

Notifying that the number of files in the save destination folder approaches the upper limit (9999) (Write 
device: System signal 2-1.b12)

[System Signal 2-1]
(Not available to GT SoftGOT2000)

Function Setting item

Notifying the connection status between the GOT and a printer. (Write device)
The following printers are supported: PictBridge-compatible printers.

GS258.b0
(Not available to GT25-W, GT2505-V, GT25HS-V, 
GT23, GT21, GT SoftGOT2000, GS25, and GS21)

Notifying the occurrence of a warning-level error. (Write device)
The following printers are supported: PictBridge-compatible printers.

GS258.b1
(Not available to GT25-W, GT2505-V, GT25HS-V, 
GT23, GT21, GT SoftGOT2000, GS25, and GS21)

Notifying the occurrence of a fatal-level error. (Write device)
The following printers are supported: PictBridge-compatible printers.

GS258.b2
(Not available to GT25-W, GT2505-V, GT25HS-V, 
GT23, GT21, GT SoftGOT2000, GS25, and GS21)

Notifying that the printer is ready or not. (Write device)
The following printers are supported: PictBridge-compatible printers, serial printers, and 
Ethernet printers.

GS258.b3
(Not available to GT SoftGOT2000)

Notifying the error code of the latest error that has occurred in the printer. (Write device)
The following printers are supported: Ethernet printers.

GS259
(Not available to GT SoftGOT2000)

Outputting page numbers with a numerical print. (Write device) GS278

Disabling automatic page breaks when the number of printed lines reaches the number of 
lines specified in the [Report Setting] dialog. (Read device)

GS524.b0
(Not available to GT SoftGOT2000)

Inserting a page break when GS524.b0 is on. (Read device)
GS524.b1
(Not available to GT SoftGOT2000)

Setting a wait time for communication and drawing to complete.
GS526
(Available to GT27, GT25, and GS25.)

Outputting the number of outputted screen images.
GS693
(Available to GT27, GT25, and GS25.)
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9.8 Controlling Operations with Scripts ([Script])

9.8.1 Overview of the script function

Scripts allow you to control the GOT display with the GOT's original programs.
By controlling the GOT display with scripts in the GOT, you can significantly reduce the load for the display of the system 
(controllers).

9.8.2 Features of the script function

■1 Easy system maintenance
With scripts, the controllers can be programmed to handle machine control only, so the system maintenance becomes much 
easier.

■2 Various screen controls available together with the GOT
Using scripts enables the following operations that could not be achieved by the GOT alone.

(1) Operations together with other object functions
• The status of multiple bit devices can be indicated by one lamp.
• A specific part can be displayed if any of the bit devices is on, and hidden if all of them are off.
• When a numerical value is input, the part which indicates that it has already been input is pasted next to the then 

input numerical display frame.
• One touch switch can perform multiple operations corresponding to the status in multiple situations.
• The error handling screen appears automatically upon the detection of a GOT error. (The GOT Error Code device of 

the system information stores the error code upon its detection.)

(2) Processing complicated arithmetic operations
• Polynomial operations can be expressed simply in a line, which are difficult for ladder programs to express.

• In addition to four arithmetic operations, scripts can be used for various application arithmetic operation functions 
such as trigonometric and exponential functions.

(3) No limit on application
• You can obtain a target date using an entered date and interval (number of days in between).

What is the date after 345 days from May 20th, 2012? →April 30th, 2013.
• You can obtain the corresponding day of the week from an entered date.

What day of the week was February 21st, 1961? →Tuesday.

■3 Simple programming language
Scripts are in a language similar to C language, so you can easily make a program with elementary programming 
knowledge.

■4 Programming using a commercially available text editor
Commercially-available text editors (such as the Microsoft Windows standard memo pad and Wordpad) which you may use 
every day can be used for programming, so you can improve program productivity.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ladder program Script

[w:D5]=([w:D1]-[w:D2])/100+([w:D3]-[w:D4])/100;
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■5 Operating conditions settable for each script
Various conditions can be set as triggers for a script, so script execution can be scheduled.
In addition to the above conditions, the execution of an object script can be tied to an input to the object, display on the 
object, or a touch on a touch switch.
GT21 and GS21 do not support the object script function.

■6 A wide variety of the debug functions
Since scripts and C language are similar, you can simulate the scripts by making minor corrections using a general C 
language complier or debugger.
Complicated scripts including many control statements can be debugged easily by using them.
The device monitor is useful for debugging controllers using the GOT.
The test function and device monitor are available to check conditional branches in a script.
By monitoring the GOT special register (GS), error information and scripts in execution can be easily checked.

■7 Syntax check of the created scripts
You can check the syntax of a created script on GT Designer3 before running the script on the GOT, improving programming 
efficiency.

■8 Converting the script language of SCHNEIDER EJH software
You can convert the D-Scripts or Global D-Scripts of SCHNEIDER EJH software so that the scripts run on the GOT.
To convert the script language, use GT Converter2.
For the details of the data to be converted and the conversion method, refer to the following.

➟GT Converter2 Version3 Operating Manual for GT Works3
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.8 Controlling Operations with Scripts ([Script])

9 - 335



9.8.3 Script types

The following four types of scripts are supported.

Type Description Supported 
models

Project script
Project scripts are set and operate for the whole project.
For the details of project scripts, refer to the following.

➟9.9 Project Script, Screen Script, and Script Part

Screen script

Screen scripts are set and operate for each base screen and window screen (superimpose 
windows and overlap windows).
For the details of screen scripts, refer to the following.

➟9.9 Project Script, Screen Script, and Script Part

Script part

A script parts object is placed on a base screen or a window screen (superimpose window 
or overlap window), and the script set for the object runs.
For the details of script parts, refer to the following.

➟9.9 Project Script, Screen Script, and Script Part

Object script

Object scripts are set and operate for the following objects.
• Touch switch ([Switch] only)
• [Bit Lamp]
• [Word Lamp]
• [Numerical Display]
• [Numerical Input]
• [Text Display]
• [Text Input]
• [Date Display]
• [Time Display]
• [Bit Comment]
• [Word Comment]
• [Parts Display]
• [Parts Movement]
• [Line Graph]
• [Trend Graph]
• [Bar Graph]
• [Statistics Bar Graph]
• [Statistics Pie Graph]
• [Scatter Graph]
• [Historical Trend Graph]
• [Graphical Meter]
• [Level]
• [Panelmeter]
For the details of object scripts, refer to the following.

➟9.10 Object Script

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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9.9 Project Script, Screen Script, and Script Part

9.9.1 Overview of a project script, screen script, and script part

■1 Overview of a project script
Set a project script for the current project.
If the trigger condition of the script is satisfied, the script runs.
A created script can be specified in a project script setting or a screen script setting.
If you edit the script, the edit will affect the project script setting or screen script setting.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Script No.: 1

Trigger condition: Rise (X0000)

Script No.: 1

Trigger condition: Rise (X0001)

Script No.: 3

Trigger condition: 

Sampling (3 seconds)

Created scripts (Script list)

Script No. 1 Script No. 2 Script No. 3

Project scriptProject script Project script

Project
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■2 Overview of a screen script
Set a screen script for the user-specified screen.
While the GOT displays the screen, if the trigger condition of the script is satisfied, the script runs.
A created script can be specified in a project script setting or a screen script setting.
If you edit the script, the edit will affect the project script setting or screen script setting.

Window screen 1Base screen 1 Base screen 2

Script No.: 1

Trigger condition: Rise (X0000)

Script No.: 1

Trigger condition: Rise (X0001)

Script No.: 3

Trigger condition: 

Sampling (3 seconds)

Screen script Screen script Screen script

Created scripts (Script list)

Script No. 1 Script No. 2 Script No. 3
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■3 Overview of a script part
Place a script parts object on a screen to create a script.
While the GOT displays the screen having a script parts object, if the trigger condition of the created script is satisfied, 
the script runs.
Each script parts object has its own scripts.
If you edit a script of a script parts object, the edit will not affect the other script parts objects.
The following object manipulations are supported.

• Copying to another screen
• Grouping
• Registering to the library
• Adding to a template

A script parts object is visible only on the screen editor of GT Designer3.
The object is invisible on the GOT screen.

9.9.2 Specifications of a project script, screen script, and script part

■1 Specifications related to a script setting
A script setting consists of a script trigger condition and a script.
The setting target, and the maximum numbers of script settings and scripts vary depending on the script type.

*1 For GT21 and GS21, screen scripts are not settable for window screens.

Window screen 1

Script part

Base screen 1

Script part

Base screen 2

Script part

Trigger condition: Rise (X0000) Trigger condition: Rise (X0001)
Trigger condition: 
Sampling (3 seconds)

Script Script Script

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Script type Setting target Maximum number of script 
settings Maximum number of scripts

Project script Project 256
32767 (in both the project script 
settings and the screen script 
settings)Screen script

• Base screen
• Window screen (superimpose 

window or overlap window) *1

256 per screen
(The script settings for called 
screens are included.)

Script part

Maximum number of script parts 
objects: 32 per screen
Maximum number of script 
settings: 16 per object

16 per object
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■2 Specifications related to the behavior of a script
The following shows the specifications related to the behavior of a script.

(1) Specifications of a screen script and script part
The following shows the behavior of a script when the set overlay screen function or a parts display object displays the 
screen for which the script is set.

■3 Control structures for a project script, screen script, and script part
The following explains the control structures for scripts.
Program scripts using the following commands (including control statements, operators, and functions).
You can describe nests (hierarchy) for if, while, and switch statements.
End a script using a return statement.

(1) Control statement

Script type Execution condition Number of executable scripts

Project script

The trigger condition of a script is satisfied.
(Except under conditions where the GOT stops 
monitoring for reasons including receiving package 
data.)

256

Screen script The trigger condition of a script is satisfied while the 
GOT displays the screen for which the script is set.
(Except under conditions where the GOT stops 
monitoring for reasons including receiving package 
data.)

256 per screen (in both the screen script settings and 
the script settings of script parts objects)Script part

Function Behavior

Set overlay screen

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
If a calling screen calls a called screen for which a screen script or a script part is set, the script runs.

• For GT21 and GS21
If a calling screen calls a called screen for which a screen script or a script part is set, the script does not run.

Parts display If a parts display object displays a screen for which a screen script or a script part is set, the script does not 
run.

Control 
statement Description

if

Syntax if (conditional expression) {statements}

Function

Performs a conditional control. The if statement evaluates (conditional expression). If the expression is true (other than 
0), {statements} is executed. 
The if statement is a fundamental conditional control and used to execute specified processing when a value satisfies 
a condition or to alter the flow of program execution.

if to else

Syntax if (conditional expression) {statements 1} else {statements 2}

Function

Performs a conditional control. The if statement evaluates (conditional expression). If the expression is true (other than 
0), {statements 1} is executed. If the expression is false (0), {statements 2} is executed. 
The if statement is a fundamental conditional control and used to execute specified processing when a value satisfies 
a condition or to alter the flow of program execution.

while 
break

Syntax while (continuous conditional expression) {statements}

Function

Evaluates (continuous conditional expression). As long as the expression is true (other than 0), {statements} is 
repeatedly executed. 
In the following cases, the iterative loop is terminated.
• When (continuous conditional expression) is false (0)
• When {statements} includes the break statement
The while statement is used to execute processing repeatedly until a target condition is satisfied. 
(For example, repeating the processing until a device value becomes 0) 
If a condition is always evaluated to true (other than 0), an infinite loop is created. 
Use the temporary device area or a GOT internal device as the write destination.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Operator (logic)

(3) Operator (relation)

switch 
case 
default 
break

Syntax

switch (target) 
{ 
case constant: statements; break; 
case constant: statements; break; 
default: statements; 
}

Function

Create a control statement using the combination of four reserved words (switch, case, break, and default). 
In the following cases, the statements that follow a case statement and the default statement are executed.
• When (target) matches a specified constant
• When (target) does not match any constant that case statements have and when there is the default statement
In the following cases, the switch body {} is terminated.
• When there is a break statement in the script
• When there is no case statement or default statement that has the constant that matches (target)
The break statement and default statement are not required in the control statement. 
The switch statement is used when various processing are required according to the value of a variable.

return
Syntax return;

Function Terminates the script. 
A single script can have multiple return statements.

;
Syntax ;

Function Indicates the end of a line. It must be put at the end of each line.

Control 
statement Description

Operator Description

&&
Syntax if ((relevant expression) && (relevant expression) {·····}

Function If both of (relevant expression) are true, the result has 1. If either of (relevant expression) is false, the result has 0. 
(Logical AND operator)

||
Syntax if ((relevant expression) || (relevant expression)) {·····}

Function If either of (relevant expression) is true, the result has 1. If both (relevant expression) are false, the result has 0. (Logical 
OR operator)

!
Syntax if (! (relevant expression)) {·····}

Function If (relevant expression) is 0, the result has 1. Otherwise the result has 0. (Logical NOT operator)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operator Description

<
Syntax <target 1> < <target 2>

Function <target 1> is less than <target 2>. (Left-inequality operator)

<=
Syntax <target 1> <= <target 2>

Function <target 1> is less than or equal to <target 2>. (Equivalence left-inequality operator)

>
Syntax <target 1> > <target 2>

Function <target 1> is greater than <target 2>. (Right-inequality operator)

>=
Syntax <target 1> >= <target 2>

Function <target 1> is greater than or equal to <target 2>. (Equivalence right-inequality operator)

!=
Syntax <target 1> != <target 2>

Function <target 1> and <target 2> are not equal. (Inequality operator)

==
Syntax <target 1> == <target 2>

Function <target 1> and <target 2> are equal. (Equality operator)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Operator (arithmetic)

(5) Operator (bit device)

(6) Operator (assignment)

(7) Variables

Operator Description

+
Syntax <target> + <factor>

Function Adds <factor> to <target>. (Addition operator)

-
Syntax <target> - <factor>

Function Subtracts <factor> from <target>. (Subtraction operator)

*
Syntax <target> * <factor>

Function Multiplies <target> by <factor>. (Multiplication operator)

/
Syntax <target> / <factor>

Function Divides <target> by <factor>. (Division operator) 
When <factor> is 0, the script operation stops.

%
Syntax <target> % <factor>

Function Finds the remainder dividing <target> by <factor>. (Remainder operator) 
When <factor> is 0, the script operation stops.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operator Description

&
Syntax <target> & <factor>

Function Finds the logical product (AND) of <target> and <factor>. (Bit accumulation operator)

|
Syntax <target> | <factor>

Function Finds the logical add (OR) of <target> and <factor>. (Bit addition operator)

~
Syntax ~<bit>

Function Negates (inverts) <bit>. (Complement operator)

^
Syntax <target> ^ <factor>

Function Finds the exclusive logical add (XOR) of <target> and <factor>. (Bit difference operator)

<<
Syntax <target> << <factor>

Function Shifts <target> left by the number of bits specified by <factor>. (Left-shift operator)

>>
Syntax <target> >> <factor>

Function Shifts <target> right by the number of bits specified by <factor>. (Right-shift operator)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operator Description

=
Syntax <device> = <target>

Function Stores <target> in <device>. (Assignment operator)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Variable Description

Device and 
temporary 

device area

Syntax [w:GD150]

Function
Indicates a PLC CPU device, a GOT internal device, or a temporary device area. 
For devices and temporary device areas, refer to the following.

➟■4 Available data and how to express the data

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
9 - 342 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

(8) Functions (device operation)

(9) Functions (consecutive device operation)

For the data type of arguments, refer to the following.
➟9.9.12 ■3 (2) Data type settings and function definitions

*1 Set the same data type for the word device 1 and the word device 2.

(10)Functions (application arithmetic operation)

For the data type of arguments and return values, refer to the following.
➟9.9.12 ■3 (2) Data type settings and function definitions

Function Description

set

Syntax set (<bit device>)

Function Sets <bit device>.

Example set([b:M0001]);

rst

Syntax rst (<bit device>)

Function Resets <bit device>.

Example rst([b:M0001]);

alt

Syntax alt (<bit device>)

Function Inverts <bit device>.

Example alt([b:M0001]);

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Description

bmov

Syntax bmov (<word device 1>, (word device 2>, <integer>)

Function
Batch-transfers the data in the devices in the contiguous sequence, the first area of which is <word device 1>, to the 
devices in the contiguous sequence, the first area of which is <word device 2>. The number of the devices in the 
contiguous sequence is specified by <integer>.

Data type 
of 
arguments

<word device 1>, <word device 2>: specified data type *1

<integer>: long

Example bmov([w:D100],[w:D500],10);

fmov

Syntax fmov (<word device 1>, (word device 2>, <integer>)

Function Transfers the data in <word device 1> to the devices in the contiguous sequence, the first area of which is <word device 
2>. The number of the devices in the contiguous sequence is specified by <integer>.

Data type 
of 
arguments

<word device 1>, <word device 2>: specified data type *1

<integer>: long

Example fmov([w:D100],[w:D500],10);

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Description

sin

Syntax sin (<word device or constant>)

Function
Calculates the sine of a specified <word device or constant>. (Sine)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example sin([w:D100]);

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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cos

Syntax cos (<word device or constant>)

Function
Calculates the cosine of a specified <word device or constant>. (Cosine)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example cos([w:D100]);

tan

Syntax tan (<word device or constant>)

Function
Calculates the tangent of a specified <word device or constant>. (Tangent)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example tan([w:D100]);

asin

Syntax asin (<word device or constant>)

Function
Calculates the arc sine of <word device or constant>. (Arc sine)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example asin([w:D100]);

acos

Syntax acos (<word device or constant>)

Function
Calculates the arc cosine of <word device or constant>. (Arc cosine)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example acos([w:D100]);

atan

Syntax atan (<word device or constant>)

Function
Calculates the arc tangent of <word device or constant>. (Arc tangent)
Specify <word device or constant> in radian.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example atan([w:D100]);

abs

Syntax abs (<word device or constant>)

Function Calculates the absolute value of <word device or constant>. (Absolute value)

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example abs([w:D100]);

Function Description
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log

Syntax log (<word device or constant>)

Function Calculates the base-e logarithm <natural logarithm> of <word device or constant>.

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example log([w:D100]);

log10

Syntax log10 (<word device or constant>)

Function Calculates the base-10 logarithm (common logarithm) of <word device or constant>. (Common logarithm)

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example log10([w:D100]);

exp

Syntax exp (<word device or constant>)

Function Calculates the value of e raised to the power of <word device or constant>. (Exponent)

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example exp([w:D100]);

ldexp

Syntax ldexp (<word device 1 or constant 1>, <word device 2 or constant 2>)

Function Calculates the formula: <word device 1 or constant 1> × (2 raised to the power of <word device 2 or constant 2>). 
(Exponent of product)

Data type 
of 
arguments

<word device 1 or constant 1>: double
<word device 2 or constant 2>: long

Return 
value double

Example ldexp([w:D100], [w:D101]);

sqrt

Syntax sqrt (<word device or constant>)

Function Calculates the square root of <word device or constant>. (Square root)

Data type 
of 
arguments

<word device or constant>: double

Return 
value double

Example sqrt([w:D100]);

Function Description
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part

9 - 345



(11)Functions (file operation)

For the argument used for the file operation function, refer to the following.
➟■4 Available data and how to express the data

For the data type of arguments and return values, refer to the following.
➟9.9.12 ■3 (2) Data type settings and function definitions

Function Description

file_getlist

Syntax file_getlist (<folder name>, <file name>, <storage device>, <offset>, <number of files>, <maximum number of 
characters>)

Function

Extracts file names equivalent to the number of characters specified by <maximum number of characters>, and stores 
the file names in <storage device> and the following devices in the contiguous sequence.
The number of files specified by <number of files> is read from the xth file (x is specified by <offset>) counted from the 
first specified by <folder name> and <file name>.

Data type 
of 
arguments

<folder name>, <file name>, <storage device>, <offset>, <number of files>, <maximum number of characters>: long

Return 
value

long
Normal: Number of obtained files
When a specified file is nonexistent or the value of <offset> is larger than the number of existing files: 0
Error: -1

Example [s16:D500] = file_getlist("X:\\Package1\\", "*.DAT", [w:D100], 3, 2, 8);

file_getfolderl
ist

Syntax file_getfolderlist (<folder name 1>, <folder name 2>, <storage device>, <offset>, <number of folders>, <maximum 
number of characters>)

Function

In a folder specified by <folder name 1> and <folder name 2>, obtains characters of the name of the <offset>th and 
subsequent folders. Then, stores the obtained characters in <storage device> and subsequent devices.
The number of obtained characters is specified by the <maximum number of characters>, and that of target folders is 
specified by <number of folders>.

Data type 
of 
arguments

<folder name 1>, <folder name 2>, <offset>, <number of files>, <maximum number of characters>: long
<storage device>: Signed BIN32

Return 
value

long
Normal: Number of obtained folders
When a specified folder is nonexistent or the value of <offset> is larger than the number of existing folders: 0
Error: -1

Example [s16:D500] = file_getfolderlist("X:\\Package1\\", "", [w:D100], 6, 2, 8);

file_read *2

Syntax file_read (<folder name>, <file name>, <storage device>, <offset>, <number of read bytes>)

Function
Reads data of the file specified by <folder name> and <file name>, and stores the data in <storage device> and the 
following devices in the contiguous sequence.
The number of bytes specified by <number of read bytes> is read from the xth byte (x is specified by <offset>).

Data type 
of 
arguments

<folder name>, <file name>, <storage device>, <offset>, <number of read bytes>: long

Return 
value

long
Normal: Size of read data (bytes)
When <number of read bytes> is 0 or <offset> is greater than the file size: 0
Error: -1

Example [s16:D500] = file_read("X:\\Package1\\", "ARP00001.DAT", [w:D100], 4, 16);

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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file_lineread 
*2

Syntax file_lineread (<folder name>, <file name>, <storage device>, <offset>, <maximum number of read bytes>)

Function

This function is for an ASCII or Shift-JIS file.
Reads 1-line data starting from the <offset>th byte from a file specified by <folder name> and <file name>, and stores 
the data in <storage device> and subsequent devices.
Data size that can be read at a time is within <maximum number of read bytes>.

Data type 
of 
arguments

<folder name>, <file name>, <storage device>, <offset>, <maximum number of read bytes>: long

Return 
value

long

Normal: Size of read data (bytes)*1

When <number of read bytes> is 0 or <offset> is greater than the file size: 0
Error: -1

Example [s16:D200] = file_lineread("X:\\Package1\\", "ARP00001.CSV", [w:D300], 0, 32);

file_unilinere
ad *2

Syntax file_unilineread (<folder name>, <file name>, <storage device>, <offset>, <maximum number of read bytes>)

Function

This function is for a Unicode file.
Reads 1-line data starting from the <offset>th byte from a file specified by <folder name> and <file name>, and stores 
the data in <storage device> and subsequent devices.
Data size that can be read at a time is within <maximum number of read bytes>.

Data type 
of 
arguments

<folder name>, <file name>, <storage device>, <offset>, <maximum number of read bytes>: long

Return 
value

long
Normal: Size of read data (bytes)*1

When <number of read bytes> is 0 or <offset> is greater than the file size: 0
Error: -1

Example [s16:D200] = file_unilineread("X:\\Package1\\", "ARP00001.txt", [w:D300], 0, 32);

file_write *2

Syntax file_write (<folder name>, <file name>, <storage device>, <offset>, <number of write bytes>, <mode>)

Function

Writes data in a manner specified by <mode>.
• New: 0

Creates the file specified by <folder name> and <file name> to which device data is written. The number of bytes 
specified by <number of write bytes> of the device data in <storage device> and the following devices in the 
contiguous sequence is written.
When the file that <file name> specifies already exists, the file is deleted and a new file is created.

• Addition: 1
Adds data equivalent to the number of bytes specified by <number of write bytes> in <storage device> and the 
following devices in the contiguous sequence to the end of the file specified by <folder name> and <file name>.
When <file name> specifies a file that does not exist, a new file is created.

• Overwrite: 2
Overwrites a position in the file specified by <folder name> and <file name> with the device data equivalent to the 
number of bytes specified by <number of write bytes> in <storage device> and the following devices in the contiguous 
sequence. The position in the file is specified by <offset>.

Data type 
of 
arguments

<folder name>, <file name>, <storage device>, <offset>, <number of write bytes>, <mode>: long

Return 
value

long
Normal: Size of written data (bytes)
Error: -1

Example [s16:D500] = file_write("X:\\Package1\\", "ARP00001.DAT", [w:D100], 4, 16, 2);

file_rename

Syntax file_rename (<folder name>, <file name>, <new file name>)

Function Changes <file name> of the file specified by <folder name> and the <file name> to <new file name>.

Data type 
of 
arguments

<folder name>, <file name>, <renamed file name>: long

Return 
value

long
Normal: 0
Error: -1

Example [s16:D500] = file_rename("X:\\Package1\\", "ARP00001.DAT", "DATA1201.DAT");

Function Description
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*1 The data which is read does not contain line feed codes but the return value contains the number of bytes containing line feed 
codes.

*2 Specify a data storage order (from higher-order bytes or from lower-order bytes) on GT Designer3 or with GS390.

file_delete

Syntax file_delete (<folder name>, <file name>)

Function Deletes a specified <file name> in <folder name>.

Data type 
of 
arguments

<folder name>, <file name>: long

Return 
value

long
Normal: 0
Error: -1

Example [s16:D500] = file_delete("X:\\Package1\\", "ARP00001.DAT");

file_copy

Syntax file_copy (<copy source folder name>, <copy source file name>, <copy destination folder name>, <copy destination file 
name>, <copy mode>)

Function

Copies the file specified by <copy source folder name> and <copy source file name> into the folder specified by <copy 
destination folder name> changing the file name to <copy destination file name>.
With <copy mode>, whether or not write protection is imposed can be specified.
When <copy destination folder name> specifies a folder that does not exist, a new folder is created and the file is pasted.
A file with the length of 0 byte is copied.

Data type 
of 
arguments

<original folder name>, <original file name>, <destination folder name>, <destination file name>, <copy mode>: long

Return 
value

long
Normal: 0
Error: -1

Example [s16:D500] = file_copy("X:\\Package1\\", "ARP00001.DAT", "B:\\backup\\", "", 1);

file_xcopy

Syntax file_xcopy (<copy source folder name 1>, <copy source folder name 2>, <copy destination folder name 1>, <copy 
destination folder name 2>, <copy mode>)

Function

Copies the folders specified by <copy source folder name 1> and <copy source folder name 2> to the folders specified 
by <copy destination folder name 1> and <copy destination folder name 2>.
With <copy mode>, whether or not write protection is imposed and sub folders are set as the target for a copy can be 
specified.

Data type 
of 
arguments

<original folder name 1>, <original folder name 2>, <destination folder name 1>, <destination folder name 2>, <copy 
mode>: long

Return 
value

long
Normal: 0
Error: -1

Example [s16:D500] = file_xcopy("X:\\Package1\\", "sample1", "B:\\backup\\", "sample1", 1);

#pragma 
folder_name_

length

Syntax #pragma folder_name_length (<maximum number of folder name characters>)

Function
Declare this function at the top of a script.
Sets <maximum number of folder name characters> when a device is specified as the folder name.

Example #pragma folder_name_length(14)

#pragma 
file_name 
_length

Syntax #pragma file_name_length (<maximum number of file name characters>)

Function
Declare this function at the top of a script.
Sets <maximum number of file name characters> when a device is specified as the file name.

Example #pragma file_name_length(12)

#pragma 
use_characte

r_code 
unicode

Syntax #pragma use_character_code unicode

Function

Declare this function at the top of a script.
Uses the characters of the folder name and file name specified in a file operation function as Unicode characters.
The characters of the folder name and file name, which are obtained using "file_getlist" or "file_getfolderlist", are 
encoded in Unicode.

Example #pragma use_character_code unicode

Setting method Description

Setting on GT Designer3
Set [File/Text Handling Function Storage Order] on the [Option] tab in the [Script] dialog.

➟9.9.5 ■4 [Option] tab

Function Description
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(a) Folder and file name character number specification functions (#pragma folder_name_length, 
#pragma file_name_ength)

• Scope
The folder and file name character number specification functions are used to specify a folder name or file name with 
a device.
If a folder name or file name is directly specified by character strings, this function is invalid.

• Maximum number of characters per folder name or file name (when these function are not used)
Up to 12 characters can be used for a folder name and file name when the folder and file name character number 
specification functions are not used.

(b) Use Unicode declare function (#pragma use_character_code unicode)
• Scope

The use Unicode declare function is used to specify the folder name and file name in a file operation function in 
Unicode.

• Character code specified without this function
The characters of the folder name and file name are encoded in ASCII.

(c) Devices used for arguments
If a controller device is used for any of the following arguments, a function using the argument takes a long time to execute.
Therefore, using a GOT internal device is recommended.

• <folder name>
• <folder name 1>
• <folder name 2>
• <file name>
• <storage device>
• <new file name>
• <copy source folder name>
• <copy source folder name 1>
• <copy source folder name 2>
• <copy source file name>
• <copy destination folder name>
• <copy destination folder name 1>
• <copy destination folder name 2>
• <copy destination file name>

Setting with GS390

Specify a data storage order with the value of GS390.
• 0 or 3 or more: Data is stored in the order specified on GT Designer3.
• 1: Data is stored from lower-order bytes.
• 2: Data is stored from higher-order bytes.

Setting method Description
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(12)Functions (string operation)

For the arguments used for the string operation functions, refer to the following.
➟■4 Available data and how to express the data

For the data type of arguments and return values, refer to the following.
➟9.9.12 ■3 (2) Data type settings and function definitions

Function Description

str_scanf

Syntax str_scanf (<input string storage device>, <input byte count>, <offset>, <format>, <input value storage device>, <input 
value storage device>, ...)

Function

Use this function to read data from an ASCII or Shift JIS string.
Stores the character string equivalent to <input byte count> extending from the xth byte (x is specified by <offset>) of 
<input string storage device> in <input value storage device> in the format specified by <format>.
Up to 10 pieces of data can be read.

Data type 
of 
arguments

<input string storage device>, <input byte count>, <offset>: long
<format>: Character string
<input value storage device>, ...: Changes the specified data type to the device type.

Return 
value

long
Normal: Number of the pieces of read data
Error: -1

Example [s16:D500] = str_scanf([w:D100], 32, 0, "%d,%4x", [w:D200], [w:D204]);

str_printf

Syntax str_printf (<output string storage device>, <output byte count>, <format>, <output value storage device>, <output value 
storage device>, ...)

Function

Use this function to write a device value in ASCII or Shift JIS code.
Writes the value of <output value storage device> equivalent to <output byte count>, starting from the first byte of 
<output string storage device> in <format>.
A null is appended to a string, and therefore specify "the number of characters + 1" for <output byte count>.
Up to 10 pieces of data can be written.

Data type 
of 
arguments

<output string storage device>, <output byte count>: long
<format>: Character string
<output value storage device>, ...: Changes the device value to the specified data type.

Return 
value

long
Normal: Size of the written character string (bytes)
Error: -1

Example [s16:D500] = str_printf([w:D100], 18, "%04d,%4x,%4.2f\r\n", [s16:D200], [s16:D300], [flt:D400]);

str_strlen

Syntax str_strlen (<input string storage device>, <input byte count>)

Function
Use this function to obtain the data length of an ASCII or Shift JIS string.
Obtains the data length of characters from the first byte of <input string storage device> to the byte specified by <input 
byte count>.

Data type 
of 
arguments

<input string storage device>, <input byte count>: long

Return 
value

long
Normal: Data length of the character string (bytes)
Error: -1

Example [s16:D500] = str_strlen([w:D100], 10);

str_strmid

Syntax str_strmid (<input string storage device>, <output string storage device>, <offset>, <string length>)

Function
Use this function to read a part of an ASCII or Shift JIS string and write the read data to a device.
Stores the character string equivalent to <string length> extending from the xth byte (x is specified by <offset>) of <input 
string storage device> in <output string storage device>.

Data type 
of 
arguments

<input string storage device>, <output string storage device>, <offset>, <string length>: long

Return 
value

long
Normal: Data length of the read string (bytes)
Error: -1

Example [s16:D500] = str_strmid([w:D100], [w:D200], 5, 7);

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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str_uniscanf

Syntax str_uniscanf (<input string storage device>, <input byte count>, <offset>, <format>, <input value storage device>, 
<input value storage device>, ...)

Function

Use this function to read data from a Unicode string.
Stores the character string equivalent to <input byte count> extending from the xth byte (x is specified by <offset>) of 
<input string storage device> in <input value storage device> in the format specified by <format>.
Up to 10 pieces of data can be read.

Data type 
of 
arguments

<input string storage device>, <input byte count>, <offset>: long
<format>: Character string
<input value storage device>, ...: Changes the specified type to the device type.

Return 
value

long
Normal: Number of the pieces of read data
Error: -1

Example [s16:D500] = str_uniscanf([w:D100], 32, 0, "%d%5s", [s16:D200], [w:D300]);

str_uniprintf

Syntax str_uniprintf (<output string storage device>, <output byte count>, <format>, <output value storage device>, <output 
value storage device>, ...)

Function

Use this function to write a device value in Unicode.
Writes the value of <output value storage device> equivalent to <output byte count>, starting from the first byte of 
<output string storage device> in <format>.
A null is appended to a string, and therefore specify "the number of characters + 2" for <output byte count>.
Up to 10 pieces of data can be written.

Data type 
of 
arguments

<output string storage device>, <output byte count>: long
<format>: Character string
<output value storage device>, ...: Changes the device value to the specified type.

Return 
value

long
Normal: Size of the written character string (bytes)
Error: -1

Example [s16:GD400] = str_uniprintf([w:GD100], 32, "%04d/t%5s\r\n", [s16:GD200], [w:GD300]);

str_unistrlen

Syntax str_unistrlen (<input string storage device>, <input byte count>)

Function
Use this function to obtain the data length of a Unicode string.
Obtains the data length of the character string stored from the first byte of <input string storage device> to the xth byte 
(x is specified by <input byte count>).

Data type 
of 
arguments

<input string storage device>, <input byte count>: long

Return 
value

long
Normal: Data length of the character string (bytes)
Error: -1

Example [s16:GD200] = str_unistrlen([w:GD100], 20);

str_unistrmid

Syntax str_unistrmid (<input string storage device>, <output string storage device>, <offset>, <string length>)

Function
Use this function to read a part of a Unicode string and write it to a device.
Stores the character string equivalent to <string length> extending from the xth byte (x is specified by <offset>) of <input 
string storage device> in <output string storage device>.

Data type 
of 
arguments

<input string storage device>, <output string storage device>, <offset>, <string length>: long

Return 
value

long
Normal: Data length of the read string (bytes)
Error: -1

Example [s16:GD400] = str_unistrmid([w:GD100], [w:GD200], 10, 5);

Function Description
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(a) Combination with the file operation function
By using a file operation function together with a string operation function, you can read data from a CSV file or Unicode 
text file, or edit the file.

(b) Devices used for arguments
If a controller device is used for any of the following arguments, a function using the argument takes a long time to execute.
Therefore, using a GOT internal device is recommended.

• <input string storage device>
• <output string storage device>
• <input value storage device>
• <output value storage device>
• <original string storage device>
• <destination string storage device>

str_lc2uni

Syntax str_lc2uni (<local code type>, <original string storage device>, <destination string storage device>, <input byte count>, 
<output byte count>)

Function

Reads characters from a string in <local code type> in <original string storage device> and subsequent devices. The 
number of read characters is specified by <input byte count>.
Encodes the read characters to Unicode, and writes the Unicode characters to <destination string storage device> and 
subsequent devices. The number of written characters is specified by <output byte count>.
A character that cannot be encoded is replaced with a space.

Data type 
of 
arguments

<local code type>, <original string storage device>, <destination string storage device>, <input byte count>, <output 
byte count>: long

Return 
value

long
Normal: Size of the written character string (bytes)
Error: -1

Example [s16:GD300] = str_lc2uni(1, [w:GD100], [w:GD200], 6, 12);

str_uni2lc

Syntax str_uni2lc (<local code type>, <original string storage device>, <destination string storage device>, <input byte count>, 
<output byte count>)

Function

Reads characters from a Unicode string in <original string storage device> and subsequent devices. The number of 
read characters is specified by <input byte count>.
Encodes the read characters to <local code type>, and writes the encoded characters to <destination string storage 
device> and subsequent devices. The number of written characters is specified by <output byte count>.
A character that cannot be encoded is replaced with a space.

Data type 
of 
arguments

<local code type>, <original string storage device>, <destination string storage device>, <input byte count>, <output 
byte count>: long

Return 
value

long
Normal: Size of the written character string (bytes)
Error: -1

Example [s16:GD300] = str_uni2lc(3, [w:GD100], [w:GD200], 12, 6);

Function Description
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(13)Others

■4 Available data and how to express the data
The following describes available data used for project scripts and screen scripts and how to express them.

(1) Data type of scripts
The following data types are provided for scripts.
• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]
The data types are fixed for each script.
To operate different types of data, using the integer←→real number conversion function enables you to handle integral 
device values as real numbers for each script.

➟(16) Integer←→real number conversion function
Select a data type when creating a monitor screen with GT Designer3.

Item Description

Constant

Syntax 1234

Function
Constant (decimal number, hexadecimal number, BCD, real number, character string)
For the details of the constants, refer to the following.

➟■4 Available data and how to express the data

#pragma 
use_ptmp_le
ngth

Syntax #pragma use_ptmp_length (<points to be used>)

Function

This function is usable in the scripts of a script parts object only.
Declare this function at the top of a script.
Specifies the maximum number of script parts temporary device areas (PTMP) ranging from 1 to 32768.
If this function is not declared, the maximum number of PTMPs is specified as shown below.
• GT27, GT25, GT23, GT SoftGOT2000, GS25

1024 (PTMP0 to PTMP1023)
• GT21, GS21

256 (PTMP0 to PTMP255)

Example #pragma use_ptmp_length (32768)

Local Symbol 
Definition

Syntax #defsym <symbol name> <symbol definition>

Function

Defines <symbol name>.
Replaces the contents of <symbol name> in a script with those of <symbol definition> while the script is running.
Even if a same-name symbol of the following types already exists in the script, the symbol name will be replaced with 
the symbol definition by #defsym.
• Script symbol
• Script parts symbol
• Object script symbol
The set symbol definition is effective from the definition line to the end of the script.

Example #defsym XYZ 10

Comment
Syntax // (comment)

Function A comment can be described in (comment).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Available constants and how to express the constants
The following four constants are provided for scripts.

However, available constants and the data range are determined according to the data type of each script as shown 
below.

*1 When a value exceeding the number of digits to which a real number is accurate is set, the set value and the operating 
value differ.
For a real number, set the number of digits not exceeding the number of digits to which the real number is accurate.

*2 The real number precision is given to 6-digit.
*3 The real number precision is given to 14-digit.
*4 When a real number (32 bits or 64 bits) is mixed in the formula of a single, if, switch, or while statement, the precision is 

reduced to 14 digits, which is the precision of real numbers (64 bits).

Constant Expression example Remarks

Decimal number 124
When the data type is 64-bit, append LL to the constant number.
Example) 124LL

Hexadecimal number 0xFF12, 0x14AC67F1
When the data type is 64-bit, append LL to the constant number.
Example) 0xFF12LL

BCD 344
When the data type is 64-bit, append LL to the constant number.
Example) 344LL

Real number 32.124, 3.2124e + 10
When the data type is 64-bit, append LF to the constant number.
Example) 3.2124e+10LF

Data type Available constant Available data range

Signed BIN16
Decimal number -32768 to 32767

Hexadecimal number 0 to FFFF

Unsigned BIN16
Decimal number 0 to 65535

Hexadecimal number 0 to FFFF

Signed BIN32
Decimal number -2147483648 to 2147483647

Hexadecimal number 0 to FFFFFFFF

Unsigned BIN32
Decimal number 0 to 4294967295

Hexadecimal number 0 to FFFFFFFF

Signed BIN64*4
Decimal number -9223372036854775808 to 9223372036854775807

Hexadecimal number 0 to FFFFFFFFFFFFFFFF

Unsigned BIN64*4
Decimal number 0 to 18446744073709551615

Hexadecimal number 0 to FFFFFFFFFFFFFFFF

BCD16 BCD 0 to 9999

BCD32 BCD 0 to 99999999

BCD64 BCD 0 to 9999999999999999

Real(32bit)*1 Real number 0, ±1.17550e-38 to 3.40282e+38*2

Real(64bit)*1 Real number 0, ±2.2250738585073e-308 to 1.7976931348623e+308*3
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(3) Available devices and how to express the devices
Scripts use the same devices as the ones used by other monitor functions.
Expressions of devices differ according to the device type and whether a station is specified or not.
Devices which can be monitored by the GOT depend on the PLC CPU to be monitored.

➟12.4 Device Range and Settings of Each Controller
To readily specify a device in the device setting screen, use the input navigation in the [Edit Script (script name)] dialog.

➟9.9.7 [Edit Script(script name)] dialog

Device type Statement example Expression example Supported 
models

Word device [w: Device No.] *1 [w:D100]

Word device (offset) *6 [w: Device No.[w: Offset device No.]] *1*2*3 [w:D100[w:D0]]

Bit device [b: Device No.] *1 [b:X100]

Bit device (offset) *6 [b: Device No.[w: Offset device No.]] *1*2*3 [b:X100[w:D0]]

Word device specified as bit device [b: Device No.. Bit location] *1 [b:D100.b1]

Bit device specified as word device [w: Device No.] *1 [w:X100]

Station number-specified device *4 [Network No.-station number:w: device No.] *1 [0-FF:w:D100]

Multiple CPU No. specification *5 [Network No.-station number/CPU No.:w: device No.] [0-FF/1:w:D100]

Block No. specification for extension 
file register *7

[w: ER block No.-device No.] [w:ER255-100]

Specifying the start I/O No. of the buffer 
memory (BM) *8

[w: BM buffer memory start I/O No.-device No.] [w:BM1E-100]

Specifying the unit No. of the buffer 
memory (G) *9

[w: U Unit No.-G device No.] [w:U2F-G100]

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part

9 - 355



Specifying the SFC block No. of the 
step relay (block) (BLS) *10 [b: BL SFC block No.-S device No.] [b:BL2-S100]

Specifying the axis No. for the servo 
amplifier device *11

[w: A Axis No.-device No.] [w:A1-PA3]

[w: U Unit No.-A Axis No.-device No.] [w:U2F-A1-PA3]

Channel specification *12*13 [@Channel No.:w: device No.] [@3:w:D100]

System label *14 [<t:System Label Name>] [<t:System Label Name>]

Global 
Label *15

Bit [gl_b::(Global Label Name)] [4-5:gl_b::Global label Name]

Word [gl_w::(Global Label Name)] [4-5:gl_w::Global label Name]

Signed BIN16 [gl_s16::(Global Label Name)] [4-5:gl_s16::Global label Name]

Unsigned BIN16 [gl_u16::(Global Label Name)] [4-5:gl_u16::Global label Name]

Signed BIN32 [gl_s32::(Global Label Name)] [4-5:gl_s32::Global label Name]

Unsigned BIN32 [gl_u32::(Global Label Name)] [4-5:gl_u32::Global label Name]

Real(32bit) [gl_flt::(Global Label Name)] [4-5:gl_flt::Global label Name]

Real(64bit) [gl_flt64::(Global Label Name)] [4-5:gl_flt::Global label Name]

Global 
label 
(Motion 
Control 
Setting 
Function) 
*15*20

Bit [gl_b::U (Module No.)-(Global Label Name)] [4-5:gl_b::U Module No.-Global 
label Name]

Word [gl_w::U (Module No.)-(Global Label Name)] [4-5:gl_w::U Module No.-Global 
label Name]

Signed BIN16 [gl_s16::U (Module No.)-(Global Label Name)] [4-5:gl_s16::U Module No.-Global 
label Name]

Unsigned BIN16 [gl_u16::U (Module No.)-(Global Label Name)] [4-5:gl_u16::U Module No.-Global 
label Name]

Signed BIN32 [gl_s32::U (Module No.)-(Global Label Name)] [4-5:gl_s32::U Module No.-Global 
label Name]

Unsigned BIN32 [gl_u32::U (Module No.)-(Global Label Name)] [4-5:gl_u32::U Module No.-Global 
label Name]

Real(32bit) [gl_flt::U (Module No.)-(Global Label Name)] [4-5:gl_flt::U Module No.-Global 
label Name]

Real(64bit) [gl_flt64::U (Module No.)-(Global Label Name)] [4-5:gl_flt::U Module No.-Global 
label Name]

Label (GT Designer3) *16 [<$:Group Name:Label Name>] [<$:Group Name:Label Name>]

Device type Statement example Expression example Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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*1 Depending on the PLC CPU device to be monitored, the device number may need to be expressed with the number of digits 
shown in the following table.

*2 Available data range is 16 bits (-32768 to 32767).
*3 If a data type other than [w:] is specified for the offset device No., the offset can be used within the range appropriate for the 

data type.
*4 To specify the host station or all stations, specification of a network number and station number can be omitted.

However, enter 0-0 to specify all stations for monitoring MODBUS salve equipment.
*5 Even if the target PLC is the host station (0-FF), station specification must be performed.
*6 For the details of the offset devices, refer to the following.

➟(15) Offset device specification

OMRON 
NJ/NX tag 
*17

Bit [gl_b::(Tag Name)] [4-5:gl_b::Tag name]

Word [gl_w::(Tag Name)] [4-5:gl_w::Tag name]

Signed BIN16 [gl_s16::(Tag Name)] [4-5:gl_s16::Tag name]

Unsigned BIN16 [gl_u16::(Tag Name)] [4-5:gl_u16::Tag name]

Signed BIN32 [gl_s32::(Tag Name)] [4-5:gl_s32::Tag name]

Unsigned BIN32 [gl_u32::(Tag Name)] [4-5:gl_u32::Tag name]

Signed BIN64 [gl_s64::(Tag Name)] [4-5:gl_s64::Tag name]

Unsigned BIN64 [gl_u64::(Tag Name)] [4-5:gl_u64::Tag name]

Signed BIN8 [gl_s8::(Tag Name)] [4-5:gl_s8::Tag name]

Unsigned BIN8 [gl_u8::(Tag Name)] [4-5:gl_u8::Tag name]

Real(32bit) [gl_flt::(Tag Name)] [4-5:gl_flt::Tag name]

Real(64bit) [gl_flt64::(Tag Name)] [4-5:gl_flt64::Tag name]

AB native 
tag *18

Bit [gl_b::(Tag Name)] [4-5:gl_b::Tag name]

Word [gl_w::(Tag Name)] [4-5:gl_w::Tag name]

Signed BIN16 [gl_s16::(Tag Name)] [4-5:gl_s16::Tag name]

Unsigned BIN16 [gl_u16::(Tag Name)] [4-5:gl_u16::Tag name]

Signed BIN32 [gl_s32::(Tag Name)] [4-5:gl_s32::Tag name]

Unsigned BIN32 [gl_u32::(Tag Name)] [4-5:gl_u32::Tag name]

Real(32bit) [gl_flt::(Tag Name)] [4-5:gl_flt::Tag name]

OPC UA 
tag *19

Bit [ou_b::&(Tag Name)] [@2:ou_b::&(Tag Name)]

Word [ou_w::&(Tag Name)] [@2:ou_w::&(Tag Name)]

Signed BIN16 [ou_s16::&(Tag Name)] [@2:ou_s16::&(Tag Name)]

Unsigned BIN16 [ou_u16::&(Tag Name)] [@2:ou_u16::&(Tag Name)]

Signed BIN32 [ou_s32::&(Tag Name)] [@2:ou_s32::&(Tag Name)]

Unsigned BIN32 [ou_u32::&(Tag Name)] [@2:ou_u32::&(Tag Name)]

Real(32bit) [ou_flt::&(Tag Name)] [@2:ou_flt::&(Tag Name)]

PLC CPU Device name

Number of digits

Expression example RemarksWord 
specificati

on

Bit 
specificati

on

OMRON PLC
.. - 2 [b:..2303]

Since the form is Channel + Relay, specify the 
relay part with a two-digit number.LR, AR, HR, 

WR - 2 [b:HR207]

ALLEN-BRADLEY PLC

B 6 7 [w:B000003] 
[b:MB02343]

Specify the file No. and element No. with a 
three-digit number, and the bit location with a 
single-digit number.

N, TP, TA, CP, 
CA 6 - [w:N007255]

Specify the file No. and element No. with a 
three-digit number.TT, TN, CU, 

CD, CN - 6 [b:TT004255]

SIEMENS PLC D - 9 [w:D000100000]
Specify Data Block (DB) with a four-digit 
number and DataWord (DW) with a five-digit 
number.

Device type Statement example Expression example Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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*7 Can be set only when an ER device is used.
*8 The start I/O No. can be specified only when a BM device is used.
*9 The unit No. can be specified only when a G device is used.
*10 The SFC block No. can be specified only when a BLS device is used.
*11 The axis No. can be specified only when a device of the servo amplifier is used.

The unit No. can be specified only when the target device is monitored through a simple motion module.
*12 When specifying both a channel No. and a station number, specify the channel No. first. (Example: [@3:0-FF:w:D100])
*13 When specifying a device of channel No.1, specification of the channel No. (@channel No.:) can be omitted.

([@1:w:D100] can also be expressed as [w:D100] by omitting "@1:" part.)
*14 Can be set only when [Use system labels in conjunction with MELSOFT Navigator] is checked in the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
*15 Settable only when an RCPU model is set in the [Controller Setting] window.

➟5.5 Configuring the Communication Method between the GOT and the Controller ([Controller Setting])
*16 Settable only when a label (GT Designer3) is registered.

➟6.1.5 How to set labels (GT Designer3)
*17 Settable only when [OMRON NJ/NX] is set for the controller type in the [Controller Setting] window.

➟5.5 Configuring the Communication Method between the GOT and the Controller ([Controller Setting])
*18 Settable only when [AB Control/CompactLogix(Tag)] is set for the controller type in the [Controller Setting] window.

➟5.5 Configuring the Communication Method between the GOT and the Controller ([Controller Setting])
*19 Settable only when [OPC UA] is selected for the controller type in the [Controller Setting] window.

➟5.5 Configuring the Communication Method between the GOT and the Controller ([Controller Setting])
*20 For the global label created by the Motion Control Setting Function, specify the module number.

Specify the second and third values of the start I/O number of the connected Motion module.
Example) When the start I/O number is 0FE0, set FE to module number.

(4) Available arguments and how to express the arguments
GT21 and GS21 do not support the file operation functions.
The following shows available arguments for the file operation function of scripts.

Argument Expression example Available data range

Folder name *1
Folder name 1 *1
Folder name 2 *1
Copy source folder name *1
Copy source folder name 1 *1
Copy source folder name 2 *1
Copy destination folder name *1
Copy destination folder name 1 *1
Copy destination folder name 2 *1

For specifying with character strings: 
"X:\\Package1\\" 
For specifying with devices: [w:D0001]

The following drives can be specified. 
A, B, E, F, G, X 
The total number of the characters of a folder name and a 
file name must be 78 or less. 
This specification is also applied to a case where multiple 
arguments are used to specify a folder name or file name.
➟(6) Folder names and file names
An argument can be specified using a device.
➟(3) Available devices and how to express the devices

File name *1
Copy source file name *1
Copy destination file name *1

For specifying with character strings: 
"FILE00001.CSV" 
For specifying with devices: [w:D0001]

New file name *1
For specifying with character strings: 
"FILE00001.BAK" 
For specifying with devices: [w:D0001]

Storage device *1 [w:GD200]

For applicable devices, refer to the following.
➟(3) Available devices and how to express the devices
Bit devices and the word specification of bit devices cannot 
be used.

Number of folders 
Number of files 1

The setting range is 1 to 32. 
An argument can be specified using a device.
➟(3) Available devices and how to express the devices
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Offset 0

• For the file operation function 
16 bits: 0 to 65535 
32 bits: 0 to 2147483647 
When the offset is used for the file name obtaining 
function (file_getlist), only 16 bits can be specified. 
When the file write function (file_write) is used, the offset 
is available only when <mode> is 2 (overwrite). 
For a mode other than overwrite, set 0 for the offset.

• For the string operation function (str_scanf, str_strmid) 
0 to 255

• For the string operation function (str_uniscanf, 
str_unistrmid) 
0 to 510 
Make sure to set an even number.

An argument can be specified using a device.
➟(3) Available devices and how to express the devices
For the details of the offset, refer to the following.
➟(5) How to use the offset

Maximum number of characters 8
The setting range is 1 to 78. 
An argument can be specified using a device.
➟(3) Available devices and how to express the devices

Number of read bytes
For specifying with character strings: 32 
For specifying with devices: [w:GD200]

The setting range is 1 to 2048. 
An argument can be specified using a device.
➟(3) Available devices and how to express the devicesNumber of write bytes

Input byte count

For specifying with character strings: 32 
For specifying with devices: [w:GD200]

• For str_scanf, str_printf, str_strlen, str_strmid, and 
str_lc2uni 
1 to 256

• For str_uniscanf, str_uniprintf, str_unistrlen, str_unistrmid, 
and str_uni2lc 
2 to 512

An argument can be specified using a device.
➟(3) Available devices and how to express the devices

String length

Output byte count

Maximum number of read bytes 256

The setting range is 1 to 256. 
Set an even number in "file_unilineread". 
An argument can be specified using a device.
➟(3) Available devices and how to express the devices

Mode 0

The following shows the setting range.
• 0: New
• 1: Addition
• 2: Overwrite
For operations of the file write function (file_write) for each 
mode, refer to the following.
➟■3 Control structures for a project script, screen script, 

and script part
An argument can be specified using a device.
➟(3) Available devices and how to express the devices

Copy mode For specifying with character strings: 3 For 
specifying with devices: [w:D0001]

The setting range is 0 to 3. 
Each bit of the setting value determines the copy mode.
• Bit 0 

0: Prohibits overwriting a file. 
1: Allows overwriting a file.

• Bit 1 
0: Does not copy subfolders. 
1: Copies subfolders.

• Bit 2 to 15: Use prohibited
An argument can be specified using a device.
➟(3) Available devices and how to express the devices

Maximum number of folder name 
characters 12 The setting range is 1 to 78.

Maximum number of file name 
characters 12 The setting range is 1 to 78.

Input string storage device *1
[w:GD200]

For applicable devices, refer to the following.
➟(3) Available devices and how to express the devicesOutput string storage device *1

Argument Expression example Available data range
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*1 An error occurs if a primitive data type label is set.
When using a label, set an array-type or structure-type label.

(5) How to use the offset
The offset is the argument which represents the storage location of the target data in a folder or file.
To express the storage location of the target data with the offset, a start folder or file is regarded as zeroth one (or zeroth 
byte).
The following shows an application example of the offset using the file read function (file_read).
Example) Offset of the file name ARP00001.DAT:
If the data starting from the forth byte is read for six bytes (for number of read bytes) and stored to storage device D100 
and later devices
[s16:D500] = file_read("A:\\Package1\\", "ARP00001.DAT", [w:D100], 4, 6); //Reads file

(6) Folder names and file names
Not available to GT21 and GS21.

(a) How to use the delimiter (\)
To specify a folder name with character strings, use \\ in a path as a delimiter.
In the file operation function, the first \ is recognized as a control character.
Therefore, unless the delimiter is used as \\, the path is not correctly specified and an error occurs.
Example) A:\Package\ (actual path) → A:\\Package\\ (path used as an argument)
To specify a folder name with devices, do not use \\ as a delimiter.
The path is not correctly specified and an error occurs.

(b) Restrictions for folder names and file names
For the character strings available and unavailable for folder names and file names, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

Format
For specifying with character strings: 
"%d,%5s" 
For specifying with comments: cmt(1, 3)

• For specifying with character strings: 
Number of characters: 256 characters or less 
Number of format specifiers: 10 or less 
Enclose a format specifier in double quotation marks.

➟(7) How to specify a format
• For specifying with comments: 

cmt (comment group, comment No.) 
Comment group: 1 to 255 
Comment No.: 1 to 32767 
Only the comments registered in the comment group can 
be used.

Input value storage device *1
[w:GD200]

For applicable devices, refer to the following.
➟(3) Available devices and how to express the devicesOutput value storage device *1

Local code type 1

The following shows the setting range.
• 0: Depends on the system language. (ASCII for English, 

Shift JIS for other languages)
• 1: Shift JIS
• 2: ASCII
• 3: GB
• 4: KS
• 5: Big5

Conversion source string storage device 
*1

[w:GD200]
For applicable devices, refer to the following.
➟(3) Available devices and how to express the devicesConversion destination string storage 

device *1

Argument Expression example Available data range

Package1

ARP00001.DAT

Drive A

D100 2 4
D101 8 6
D102 2 1

Storage device

1 0 5 8 4 2 6 8 1 2 3 …

Regarded as the zeroth byte.

Reads 6 bytes after the fourth byte of 
ARP00001.DAT to store the bytes in 
D100 and the subsequent devices.
9 - 360 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

(c) Specifying with wild cards
Only when the file name obtaining function (file_getlist) is used, you can use wild cards to specify a file name.
Wild cards handle an unknown part of the name as character strings.
The part specified by wild cards can be any character strings.
The following shows application examples of wild cards.
Example) For obtaining the file stored in the folder A:\\Package1\\ and the name starts with ARP and ends with DAT
[s16:D500] = file_getlist("A:\\Package1\\", "ARP*.DAT", [w:GD100], 0, 5, 12); //Obtains file name

Use wild cards under the following conditions.
• Only [*] can be used as the wild card.

Example of valid use: ARP*.DAT
Example of invalid use: ARP?????.DAT

• Only one [*] can be used in an argument.
However, you can use [*.*] as an exception.
Example of valid use: *.DAT
Example of invalid use: ARP*.*

• When [*] is used in the file name of the script, [*] can be placed only right before [.] (period).
Example of valid use: ARP*.DAT
Example of invalid use: ARP*01.DAT

• When [*] is used in the extension part of the file name of the script, the extension must consist of the wild card only.
Example of valid use: ARP00001.*
Example of invalid use: ARP00001.*AT

(7) How to specify a format
Specify a format using format specifiers and escape sequences.

(a) Specifying a format with comments
Only the comments registered in the comment group can be used.
Do not enter a line feed in the format.
The description after a line feed is not reflected in the format.

(b) Format specifier
Determines the data type for reading and writing.
The form of a format specifier differs according to the function used.
Describe one format specifier for one data.
The number of format specifiers must be the same as the number of devices, which are the storage locations of read or 
written data.

Package1

ARP00001.CSV
ARP00002.CSV
ARP00003.CSV
ARP00004.CSV
ARP00005.CSV
ARP00001.DAT
ARP00002.DAT
ARP00003.DAT
ARP00004.DAT
ARP00005.DAT

Drive A

Part indicated by "*"

ARP00001.DAT
ARP00002.DAT
ARP00003.DAT
ARP00004.DAT
ARP00005.DAT

Obtained character strings

ARP * .DAT

Wild card (character strings)
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(c) Escape sequence
Skips or writes control symbols.

Available format specifiers and escape sequences differ according to the functions used.
➟(8) String input function (str_scanf, str_uniscanf)
(9) String output function (str_printf, str_uniprintf)

(8) String input function (str_scanf, str_uniscanf)
Not available to GT21 and GS21.

(a) Format specifier
Describe format specifiers in the following formats.
% + flag + field width + type specifier
Description example)
For skipping one character and reading the data (field width: 5) in decimal number :%*c%5d

• Flag
The flag is the processing to be executed when the data is read.
Add a flag after % as required.

• Field width
The field width is the maximum number of characters which can be read from character strings.
When the read data is larger than the field width, the excess portion of the data which is larger than the number of 
bytes specified with the field width cannot be read.
Describe the field width in nonnegative integers.
Add a field width before a type specifier as required.

• Type specifier
Specifies the type of the data to be read from character strings.
A format specifier must be used with a type specifier.

Flag Expressio
n

Descriptio
n example Description

Skip * %*d
Skips the specified type data.
The number of the skipped data is not added to the number of the read data (return value).
(Description example: when decimal data is skipped)

Type specifier Description

c Reads one character.

s Reads character strings.

d Reads integers in decimal numbers.

lld Reads 64-bit integers in decimal.

u Reads unsigned integers in decimal numbers.

llu Reads unsigned 64-bit integers in decimal.

o Reads integers in octal numbers.

llo Reads 64-bit integers in octal.

x Reads integers in hexadecimal numbers.

llx Reads 64-bit integers in hexadecimal.

f Reads real numbers (32 bits).

lf Reads real numbers (64 bits).

[...]

Reads the characters specified with square brackets.
Reading is stopped at the time of reading characters which are not specified with the brackets.
Example)
If %[ABC] is set for a format specifier and the character string CBAGAB is read, the result is CBA.
If ^ is added to the character string in square brackets, characters other than the specified ones are read.
Reading is stopped at the time of reading the character string specified with square brackets.
Example)
If %[^ABC] is set for a format specifier and the character string DEFADE is read, the result is DEF.

% Skips a percent sign (%).
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(b) Escape sequence

(9) String output function (str_printf, str_uniprintf)
Not available to GT21 and GS21.

(a) Format specifier
Describe format specifiers in the following formats.
% + flag + field width + precision specification + type specifier
Description example)
For writing the data (field width: 5) in fixed-point numbers of four digits after the decimal point and left-aligning the numbers:
%-5.4f

• Flag
The flag is the processing to be executed when the data is written. Add a flag after % as required.

• Field width
The field width is the maximum number of characters which can be written in a field.
If the number of characters of written data exceeds the field width, a value of -1 (error) is returned.
If the written number of characters in the data is smaller than the field width, blanks are added to the remaining digits.
Describe the field width in nonnegative integers.
Add a field width before a type specifier as required.

• Precision specification
Specify a period (.) and nonnegative integers.
Every type specifier has different meanings of precision specification.
If precision specification is not added, the default value is applied.
Add a precision specification after the field width as required.

Escape sequence Description

\n Skips a line feed (LF).

\t Skips a tab.

\\ Skips a backslash (\).

\? Skips a question mark (?).

\' Skips a single quotation mark (').

\" Skips a double quotation mark (").

Flag Expression Description 
example Description

Left alignment - %-d
Left-aligns character strings when a field width is specified.
(Description example: when decimal data is written and left-aligned)

Plus sign (+) 
addition + %+d

Adds a plus sign before a numerical value and writes the data.
(Description example: when decimal data is written after a plus sign is added 
to the data)

Blank addition Blank %d
Adds a blank before a numerical value and writes the data.
(Description example: when decimal data is written after a blank is added to the 
data)

Zero padding 0 %05d
Adds a zero to blank spaces and writes the data when a field width is specified.
(Description example: when decimal data is written after a zero is added to the 
data)

Prefix addition # %#5x
Adds 0, 0x, or 0X as a prefix when octal or hexadecimal numbers are written.
(Description example: when hexadecimal data is written after 0x is added as a 
prefix to the data)

Type specifier Description Default value

c The precision specification is invalid. -

s

Specifies the maximum number of characters to be output.
The characters which exceed the value of precision specification are not output.
Example) Outputting a string of 26 alphabetic characters (A to Z)
• %s (default value): Outputting 8 characters (A to H)
• %.10s (10 characters specified): Outputting 10 characters (A to J)

8

d, u, o, x, X

Specifies the minimum value of the number of digits to be written.
If the number of digits in an argument is smaller than the specified value, Null or zero is input into the 
remaining digits. (Whether either one is input into the digits differs according to a flag to be specified.)
If the number of digits exceeds the value of precision specification, the value is not rounded down.

1
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*1 The values after the decimal point are not output in the following cases.
When 0 is set for the precision specification
When a period (.) is set without specifying subsequent numerical values

• Type specifier
Specifies the type of the data to be written into character strings.
A format specifier must be used with a type specifier.

(b) Escape sequence

f*1
Specifies the number of digits after the decimal point of decimal numbers.
When the decimal point is displayed, integers are displayed.
The value is rounded down until the value becomes an appropriate number of digits.

6
e, E*1

Specifies the number of digits to be output after the decimal point of decimal numbers.
Up to 39 digits can be specified for precision.
The last number of the data to be output is rounded down.

g, G
Specifies the maximum value of the number of significant digits to be written.
Up to 14 digits can be specified for precision.

Type specifier Description

c Writes one character.

s Writes character strings.

d Writes integers in signed decimal numbers.

lld Writes 64-bit integers in signed decimal.

u Writes integers in unsigned decimal numbers.

llu Writes 64-bit integers in unsigned decimal.

o Writes integers in octal numbers.

llo Writes 64-bit integers in octal.

x, X
Writes integers in hexadecimal numbers.
When X is used, alphabets in the data are capitalized.

llx, llX
Writes 64-bit integers in hexadecimal.
When X is used, alphabets in the data are capitalized.

f
Writes real numbers in real number form.
Example) 123.456

e, E

Writes real numbers in exponential form.
The exponents are displayed with three digits.
Example) 12345.6e-002
When E is used, alphabets in the data are capitalized.

g, G

Writes real numbers in an optimal form.
If an exponent is either of the following, real numbers are written in exponential form.
• Value less than -4
• Value larger than the precision value specified with the precision specification
For an exponent other than the above, real numbers are written in real number form.
When G is used, alphabets in the data are capitalized.

%
Writes a percent sign (%).
Specifying the corresponding device is not required.
Even though a field width and a flag are specified, they are invalid.

Escape sequence Description

\n Writes a line feed (LF).

\r Writes a carriage return (CR).

\t Writes a tab.

\\ Writes a backslash (\).

\? Writes a question mark (?).

\' Writes a single quotation mark (').

\" Writes a double quotation mark (").

Type specifier Description Default value
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(10)Temporary device areas and their uses
Temporary device areas are usable in a script in addition to controller devices.
Data is written to the specified temporary device areas in real time during script execution.
The GOT does not need to communicate with a controller when using temporary device areas, reducing communication 
load.
The following types of temporary device areas are supported.

The following shows the uses of these temporary device areas.

(11)Specifications of a temporary device area (TMP)
The following shows the specifications of a temporary device area (TMP).

Project scripts, screen scripts, and script parts use common TMPs.
Object scripts use different TMPs.
Accordingly, object scripts and the other types of scripts cannot exchange data using their TMPs.
To exchange data, use the GOT internal devices (GD or GB).

Type Specifications

Temporary device area (TMP)

A TMP is a global variable that is accessible by multiple scripts.
TMPs can be specified in the following scripts.
• Project script
• Screen script
• Script part
• Object script
For the details, refer to the following.

➟(11) Specifications of a temporary device area (TMP)

Script parts temporary device area (PTMP)

A PTMP is a local variable that is accessible by the scripts of each script parts object.
PTMPs can be specified in the scripts of the object or as the trigger devices to run the scripts.
For the details, refer to the following.

➟(12) Specifications of a script parts temporary device area (PTMP)

Use Description

To prevent an assignment delay

If a controller device is specified as the write destination in a script, the operation result will be written 
to the device when the script ends, resulting in an assignment delay.
If a temporary device area is specified instead, the result will be written to the area in real time 
without delay.
Example) If you manipulate a bit device, and then use the bit device in a conditional formula

For the details of the assignment delay, refer to the following.

➟9.9.12 ■1 Precautions for use

As the write destination device of a while 
statement

A device causing an assignment delay cannot be used as the write destination device of a while 
statement.
Use a temporary device area or a GOT internal device accordingly.

if(...) {
 alt([b:TMP0001.03]); //Invert TMP0001.03.
}
if([b:TMP0001.03] == ON) { //A branch is executed based on the status of TMP0001.03.
 ...
} else {
 ...
}

Item Specifications

Size
One TMP is 64 bits long.
If a TMP is used as a bit device, it is handled as 16 bits long.
The settable bit range is 0 to 15.

Initial value A TMP stores 0 when the GOT is powered on.

Maximum number of the areas

• For GT27, GT25, GT23, GT SoftGOT2000, and GS25
1024 (TMP0 to TMP1023)

• For GT21 and GS21
256 (TMP0 to TMP255)

Example of a representation

• To handle TMP0001 as a word device
[w:TMP0001]

• To handle bit 1 of TMP1023 as a bit device
[b:TMP1023.01]
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To access the same TMP from multiple scripts, set the same data type for the scripts and the same representation for 
the TMP in the scripts.
Otherwise, the stored value may be rendered invalid in the following uses.

(12)Specifications of a script parts temporary device area (PTMP)
The following shows the specifications of a script parts temporary device area (PTMP).

Each script parts object uses its own PTMPs.
The scripts of a script parts object can exchange data each other using their common PTMPs.
Script parts objects cannot exchange data each other using their PTMPs.
To exchange data, use the GOT internal devices (GD or GB) or temporary device areas (TMPs).

Invalid use Example

Scripts with different data types access 
the same TMP.

Script A (unsigned BIN16) writes a value to TMP0000, and then script B (unsigned BIN32) reads the 
value from TMP0000.

The representation of a TMP at reading 
differs from the one at writing.

Script A writes a hexadecimal value to TMP0000 represented as a word device, and then script B reads 
the value from TMP0000 represented as a bit device.

Figure conceptualizing the access to each TMP with the same number

Temporary device area

Project script Object script

Temporary device area

Script part

Screen script

[w:TMP0000] = 0x1234; //Write a value to TMP0000 as unsigned 16-bit binary data.

Script A ([Data Type]: [Unsigned BIN16])

[w:GD0000] = [w:TMP0000]) //Read the value from TMP0000 as unsigned 32-bit binary data.

Script B ([Data Type]: [Unsigned BIN32])

[w:TMP0000] = 0x3;  //Write a value to TMP0000 represented as a word device.
if([b:TMP0000.b0] == ON) {... //Read the value from TMP0000 represented as a bit device.

Item Specifications

Size
One PTMP is 32 bits long.
If a PTMP is used as a bit device, it is handled as 16 bits long.
The settable bit range is 0 to 15.

Initial value
A PTMP is reset to 0 at screen switching.
The value stored during script execution is retained until the next screen switching.

Maximum number of the areas

Using #pragma use_ptmp_length, you can specify the maximum number of PTMPs ranging from 1 
to 32768.
The default is set as shown below.
• For GT27, GT25, GT23, GT SoftGOT2000, and GS25

1024 (PTMP0 to PTMP1023)
• For GT21 and GS21

256 (PTMP0 to PTMP255)

Example of a representation

• To handle PTMP0001 as a word device
[w:PTMP0001]

• To handle bit 1 of PTMP1023 as a bit device
[b:PTMP1023.01]
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(13)How to express bit devices (system define)
The following expressions can be used for bit devices.

(a) If a relevant expression for bit devices is processed
Device values which are normally expressed with 1 or 0 can be expressed with on and off.
if([b:X100]==1){[w:D0]=100;} //If X100 is on, D0 is 100.
↓
if([b:X100]==ON){[w:D0]=100;} //If X100 is on, D0 is 100.

(b) If assignment processing of bit devices is processed
Device values which are normally expressed with the set statement, the rst statement, 1, or 0 can be expressed with on or 
off.
set([b:X100]); //X100 turns on.
[b:X100]=1; //X100 turns on.
↓
[b:X100]=ON; //X100 turns on.

(14)Substituting devices and constants by the user-defined character strings
The devices and constants in a script are substitutable by the user-defined character strings.
Define character strings as symbols for devices and constants. You can check for duplicate devices and constants, and 
apply changes of devices and constants to the script without editing the script directly.
Example) Substituting the device [b:X1000] by the character string "ERROR_CHECK"
if(ERROR_CHECK == 1) {[w:D0] = 100;} // Write 100 to D0 if ERROR_CHECK ([b:X1000]) turns on.
The following types of symbols are supported.

Figure conceptualizing the access to each PTMP with the same number

Script part 1

Script parts temporary 
device area

Script 1 Script 3

Script 2

Script part 2

Script parts temporary 
device area

Script 1 Script 3

Script 2

Symbol Description

Script symbol

Script symbols are usable in the following scripts.
• Project script
• Screen script
For information on how to set a script symbol, refer to the following.

➟9.9.5 ■3 [Script Symbol] tab

Script parts symbol

Script parts symbols are usable in the scripts of a script parts object.
Each script parts object has its own script parts symbols.
For information on how to set a script parts symbol, refer to the following.

➟9.9.10 ■2 [Script Parts Symbol] tab

Object script symbol
Object script symbols are usable in object scripts only.
For information on how to set an object script symbol, refer to the following.

➟9.9.9 [Script Symbol] dialog

Local symbol

Local symbols are usable in all types of scripts.
Local symbols are valid only in the script where they are defined.
For the local symbols, refer to the following.

➟■3 Control structures for a project script, screen script, and script part
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(15)Offset device specification
The offset device can be specified.

(a) Format
Example) When D200 is 5, 48 is stored in D105.

(b) Available devices
• Base device

Controller devices, GOT internal devices, gateway devices, and temporary device areas can be specified.
Word devices and bit devices can be used.

• Offset device
Controller devices, GOT internal devices, gateway devices, and temporary device areas can be specified.
Only word devices can be used. (Bit devices can be specified as word devices. Specify a device with a multiple of 16.)
The device cannot use when the data type is 8 bits or 64 bits.

(c) Application examples
Changing parameters according to the operation mode

• D10: For switching the operation mode
• D100 to D109: For storing parameter values
• GD500: Base device
• TMP100: Offset device

Script 1 (specifies a parameter value.)
[w:GD500]=10; //Parameter value of operation mode 1
[w:GD501]=11;
[w:GD502]=12;
:
[w:GD600]=20; //Parameter value of operation mode 2
[w:GD601]=21;
[w:GD602]=22;
:
[w:GD700]=30; //Parameter value of operation mode 3
[w:GD701]=31;
[w:GD702]=32;
Script 2 (determines an offset value according to the device value for switching the operation mode.)
switch( [w: D10] ){
case 1: //If D10 is 1, the offset value is 0.
[w:TMP100]=0;
break;
case 2: //If D10 is 2, the offset value is 100.
[w:TMP100]=100;
break;
case 3: //If D10 is 3, the offset value is 200.
[w:TMP100]=200;
break;
}
Scripts 3 (writes parameters according to the offset value.)
bmov([w:GD500[w:TMP100]],[w:D100],10); //Writes the device value of [GD500 + value of TMP100] to the devices from 
D100 to D109.
If script 2 and 3 are processed simultaneously or as one script, the scripts do not operate properly due to the switching 
delay of offsets.

[w:D100[w:D200]]=48;

Offset device
Base device
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(d) Data type of offset devices
The data type of offset devices is converted into signed BIN 16 data regardless of [Data Type] set in [Edit Script].
Example) [w:GD100] = [w:D1000[s32:GD1000]];
1) If 65535 is set to GD1000 (signed BIN 32), the equation "65535 (signed BIN 32) = -1 (signed BIN 16)" is satisfied and 
the value in D999 is assigned to GD100.
2) If 65537 is set to GD1000 (signed BIN 32), the equation "65537 (signed BIN 32) = 1 (signed BIN 16)" is satisfied and the 
value in D1001 is assigned to GD100.
Example) [w:GD100] = [w:D1000[d32:GD1000]];
If 10 is set to GD1000 (signed BIN 32), the equation "10 (signed BIN 32) = 16 (signed BIN 16)" is satisfied and the value in 
D1016 is assigned to GD100.
Example) [w:GD100] = [w:D1000[flt:GD1000]];
1) If 65535.0 is set to GD1000 (real number), the equation "65535.0 (real number) = -1 (signed BIN 16)" is satisfied and the 
value in D999 is assigned to GD100.
2) If 65537.0 is set to GD1000 (real number), the equation "65537.0 (real number) = 1 (signed BIN 16)" is satisfied and the 
value in D1001 is assigned to GD100.

(e) Delay at assignment of offset devices
If a controller device is used as a base device, delay may occur and the offset may not operate properly even though the 
offset device value is changed.
If the offset does not operate properly, use temporary device areas or GOT internal devices.

➟9.9.12 ■1 Precautions for use

(16)Integer←→real number conversion function
Not available to GT21 and GS21.
For scripts, the data type is selected for each script. However, using the integer←→real number conversion function 
enables you to use integral device values as real numbers for operation.
The integer←→real number conversion function is available only for GOT internal devices (GD).
To convert the value of a controller device, transfer the value to the GOT internal device using a script (bmov instruction).
When real numbers are converted into integers, the value after the decimal point is rounded down. (1.53 → 1)
If the real number is out of the range, an error occurs before the value after the decimal point is rounded down and the 
real number is not converted.

(a) Conversion method
The integer←→real number conversion is executed using the GOT internal device (GD) as the target to be converted.
Execute the integer←→real number conversion by specifying the following devices by scripts.
Up to 4096 points can be converted at once.
For the details of the GOT internal devices, refer to the following.

➟12.1.3 GOT special register (GS)
• Read device

Turn off the Conversion Start Indication (GS460) after completion of conversion.
If the Conversion Start Indication is executed when it is on, the device value is not converted.

Device Function Description

GS460 Conversion Start Indication

Specifies the conversion start and the conversion method with each bit. 
b0: Unsigned BIN 16 data is converted into real numbers. 
b1: Signed BIN 16 data is converted into real numbers. 
b2 and b3: Use prohibited 
b4: Real numbers are converted into unsigned BIN 16 data. 
b5: Real numbers are converted into signed BIN 16 data. 
b6 to b14: Use prohibited 
b15: This bit is turned on when conversion is executed.

GS461 Number of Conversion 
Devices Specifies the number of devices to be converted.

GS462 Conversion Source Head 
Device No.

Specifies the start device No. of the GOT internal device (GD) where the value before conversion 
is stored.

GS463 Conversion Destination Head 
Device No.

Specifies the start device No. of the GOT internal device (GD) where the conversion result is to 
be stored.

GS464 Storage Error Value
Specifies the device value to be stored in the conversion destination device when a conversion 
error occurs. 
(Using this device for error recognition may be useful.)
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• Write device

*1 The following shows the error codes to be stored in GS261.

(b) Application examples
The average value of the data (signed BIN 16) stored in controller devices is displayed on the GOT in real numbers.

• Script 1 (conversion start processing)
Transfers the values of the controller devices (D100 to D109) to the GOT internal devices (GD100 to GD109) and 
converts integer numbers to real numbers.
Script 2 is started after the conversion is started.
· Data type: Signed BIN 16
· Trigger: Rise of GB50
bmov([w:D100],[w:GD100],10);
[w:GS461]=10; //Number of devices to be converted
[w:GS462]=100; //Conversion source head device No.
[w:GS463]=200; //Conversion destination head device No.
[w:GS460]=0x8002; //Starts conversion.
set([b:GB100]); //Launches script 2.

• Script 2 (conversion completion monitor processing)
Waits completion of the conversion from integral numbers to real numbers. When no error occurs after completion 
of the conversion, the Conversion Start Indication device is cleared at the same time of starting script 3.
· Data type: Signed BIN 16
· Trigger: While GB100 is on
if([b:GS260.15]==1)
{ //Conversion is complete.
if([b:GS260.14]==0)
{
set([b:GB101]); //Conversion is complete and the status is normal. (Launches script 3.)
}
[w:GS460]=0; //Clears the conversion start trigger.

Device Function Description

GS260 Status

Stores the conversion completion notification and an error occurrence in each bit. 
If the Conversion Start Indication (GS460.b15) is turned off (0), each bit becomes 0. 
b0 to b13: Use prohibited 
b14: This bit turns on when an error occurs during conversion in the GOT. 
(An error code is stored in GS261.) 
b15: This bit turns on when conversion is finished in the GOT.

GS261 Error code*1 Stores an error which has occurred at conversion. 
When conversion is finished properly, 0 is stored in this device.

Error code Description Remarks

1 The Conversion Start Indication is not initialized.

Conversion processing is not executed.

2 The setting of the Conversion Start Indication is 
incorrectly configured.

3 The number of devices is out of range.

4 The device is out of range.

5 The conversion souse and destination are the 
same.

6 Not used -

7 Conversion error (such as an overflow) Conversion processing continues.

GD300   68.25

(a) Operates when GB50 (trigger) turns on. 
      Transfers values to GOT internal devices.

GD100     50
    :
GD109   139

(b) Converts the 
     integer numbers
     to the real numbers.

(c) Stores the average 
     value to GD300.

GD100     50
    :
GD109   139

GD300     68.25

Displays the value on the GOT.
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rst([b:GB100]); //Clears the script 2 trigger.
}

• Script 3 (Average calculation processing)
Calculates the average value of the GOT internal device values converted into real numbers and stores the average 
value in GD300.
· Data type: Real number
· Trigger: Rise of GB101
[w:TMP001]=0;
[w:TMP001]=[w:TMP001]+[w:GD200];
[w:TMP001]=[w:TMP001]+[w:GD202];
[w:TMP001]=[w:TMP001]+[w:GD204];
[w:TMP001]=[w:TMP001]+[w:GD206];
[w:TMP001]=[w:TMP001]+[w:GD208];
[w:TMP001]=[w:TMP001]+[w:GD210];
[w:TMP001]=[w:TMP001]+[w:GD212];
[w:TMP001]=[w:TMP001]+[w:GD214];
[w:TMP001]=[w:TMP001]+[w:GD216];
[w:TMP001]=[w:TMP001]+[w:GD218];
[w:GD300]=[w:TMP001]/10; //Stores the average in GD300 (real number).
rst([b:GB101]); //Clears the script 3 trigger.
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(17)Data type conversion function
Using this function enables you to calculate integral device values as real numbers much easier than using the 
integer←→real number conversion function.
The values of word devices can be converted into a specified data type for reading or writing.
Specify the data type when reading or writing the device values.
The following shows the list of the data types which can be specified with the data type conversion function.

The following shows application examples of the data type conversion function.
Example 1) If signed BIN 16 is set for [Data Type] and the average value of the device values is assigned in real numbers 
(32 bits)
[flt:D10]=([w:D20]+[w:D30]+[w:D40]+[w:D50]+[w:D60])/5;
Example 2) If the device value in real number (32 bits) is rounded down and written to the signed BIN 32 data
[s32:D100]=[flt:D200];
Example 3) If the device value in real numbers (32 bits) is rounded off and written to the signed BIN 32 data
[s32:D100]=[flt:D200]+0.5;

When converting the data type of a device value to a different data type, note the following.
• When the data type is converted from a real data type to an integer data type, the values after the decimal point are 

omitted.
• If a device value after conversion exceeds the setting range of the data type, do not convert the value.
• If a device value is negative, do not convert the data type to an unsigned data type.

Data type after 
conversion

Statement 
example Expression example

Signed BIN8 [s8:device] [s8:GB50]=[s16:D100];
Refers to the values in D100 and D101 as the signed BIN 16, converts 
the value into the signed BIN 8 data, and assigns the data to GB50 to 
GB81.

Unsigned BIN8 [u8:device] [u8:GB50]=[s16:D100];
Refers to the values in D100 and D101 as the signed BIN 16, converts 
the value into the unsigned BIN 8 data, and assigns the data to GB50 to 
GB81.

Signed BIN 16 [s16:device] [s16:D0]=[w:GD0]; Refers to the value in GD0 as the data type set in [Data Type], converts 
the value into the signed BIN 16 data, and assigns the data to D0.

Unsigned BIN 16 [u16:device] [w:GD0]=[u16:D0]; Refers to the value in D0 as the unsigned BIN 16 data, converts the 
value into the data type set in [Data Type], and assigns the data to GD0.

Signed BIN 32 [s32:device] if([s32:D0]<0){ Refers to the values in D0 and D1 as the signed BIN 32 data and 
compares the data with 0.

Unsigned BIN 32 [u32:device] [u32:GD10]=[w:GD0]*[w:GD1];
Refers to the values in GD0 and GD1 as the data type set in [Data Type], 
converts the operation results into the unsigned BIN 32 data, and 
assigns the results to GD10 and GD11.

Signed BIN64 [s64:device] [s64:W12]=[w:D100];
Refers to the values in D100 to D103 as the data type set in [Data Type], 
converts the value into the signed BIN 64 data, and assigns the data to 
W12 to W15.

Unsigned BIN64 [u64:device] [u64:D100]=[s64:D40];
Refers to the values in D40 and D43 as the signed BIN 64, converts the 
value into the unsigned BIN 64 data, and assigns the data to D100 to 
D103.

BCD16 [d16:device] [d16:GD0]=[w:D0]&0x000F; Refers to the value in D0 as the data type set in [Data Type], converts 
the operation result into BCD16 data, and assigns the result to GD0.

BCD32 [d32:device] [w:GD0]=[d32:D0];
Refers to the value in D0 and D1 as the BCD32 data, converts the 
values into the data type set in [Data Type], and assigns the values to 
GD0.

BCD64 [d64:device] [d64:D10]=[flt64:D30];
Refers to the values in D30 to D33 as the real numbers (64 bits), 
converts the values into the BCD64 data, and assigns the values to D10 
to D13.

Real(32bit) [flt:device] [flt:D100]=log([w:D200]);
Refers to the value in D200 as the data type set in [Data Type], converts 
the operation result into real numbers (32 bits), and assigns the result to 
D100 and D101.

Real(64bit) [flt64:device] [flt64:D10]=[u64:D30];
Refers to the values in D30 to D33 as the unsigned BIN 64, converts the 
values into real numbers (64 bits), and assigns the values to D10 to 
D13.
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9.9.3 How to use a project script, screen script, or script part

This section explains how to use a project script, screen script, or script part.

■1 Setting procedure
The following shows the procedure for setting a script.

(1) Procedure for setting a project script or screen script
Step 1 Configure the script settings with GT Designer3, such as the data type and trigger type.

➟9.9.5 [Script] dialog
Step 2 Create or edit a script with the script editor or a commercially available text editor.

➟9.9.7 [Edit Script(script name)] dialog
Step 3 When you have created or edited a script with a commercially available text editor, read the script with GT 

Designer3.
Step 4 Check the syntax of the script with GT Designer3.

➟9.9.7 [Edit Script(script name)] dialog
If an error is detected, return to step 1 to correct the script.
A general C language compiler is also usable to simulate the operation.
➟9.9.14 ■1 Simulation using a general C language compiler or debugger

Step 5 Write the project from the personal computer to the GOT with GT Designer3.

➟4. COMMUNICATING WITH GOT
Step 6 Start monitoring and check the script operation using the device monitor.

➟GOT2000 Series User's Manual (Monitor)
If the script runs properly, the creation of the script is complete.
If the script runs improperly, return to step 1 to correct the script.

(2) Procedure for setting a script part
When you place a script parts object on the screen editor, make sure that the object overlaps the screen display area 1 
dot or more.
Otherwise, the script set for the object does not run.

Step 1 Select [Object] → [Script Parts] from the menu.
Step 2 Click the position to place a script parts object.
Step 3 Double-click the script parts object to display the [Script Parts] dialog.

➟9.9.10 [Script Parts] dialog
Step 4 On the [Script Setting] tab, set a trigger type and a script.
Step 5 Check the syntax of the script with GT Designer3.

➟9.9.7 [Edit Script(script name)] dialog
9.9.11 [Script Edit] dialog (for script parts)
If an error is detected, return to step 4 to correct the script.
A general C language compiler is also usable to simulate the operation.
➟9.9.14 ■1 Simulation using a general C language compiler or debugger

Step 6 Write the project from the personal computer to the GOT with GT Designer3.

➟4. COMMUNICATING WITH GOT
Step 7 Start monitoring and check the script operation using the device monitor.

➟GOT2000 Series User's Manual (Monitor)
If the script runs properly, the creation of the script is complete.
If the script runs improperly, return to step 4 to correct the script.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Operation
The following shows the operation of a project script, screen script, or script part.

(1) Trigger condition
A project script, a screen script, or the script of a script parts object runs when its trigger condition is satisfied, and the 
result is written to a target PLC CPU.
The following shows the selectable trigger types.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [ON Sampling]
• [OFF Sampling]
• [Sampling] (Unit: second)
• [When closing a screen] (for screen scripts and script parts)

(2) Execution unit
Project scripts, screen scripts, and the scripts of a script parts object run one by one.
Even if the trigger conditions of multiple scripts are satisfied, the scripts do not run simultaneously.

(3) Execution order
The GOT check whether the trigger conditions of project scripts, screen scripts, and scripts of script parts objects are 
satisfied in top-to-bottom order as shown in the table below.
Depending on when the trigger device status is refreshed, the scripts may not run in the specified order even though the 
same trigger device is set for the scripts.
To control the execution order of scripts, establish a handshake between the scripts.

Priority order of screens Priority order of scripts Hierarchical order of the set overlay 
screen function

Execution order specified on GT 
Designer3

Number of 
executable 

scripts

- Project script - 1 → 2 → ... 256

Base screen

Screen script

Basic screen 1 → 2 → ...

256

Called screen of the 1st layer 1 → 2 → ...

: :

Called screen of the 16th layer 1 → 2 → ...

Script part

32 script parts objects on the basic 
screen

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

32 script parts objects on a called 
screen of the 1st layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: :

32 script parts objects on the called 
screens of the 16th layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...
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Superimpose window 1

Screen script

Basic screen 1 → 2 → ...

256

Called screen of the 1st layer 1 → 2 → ...

: :

Called screen of the 16th layer 1 → 2 → ...

Script part

32 script parts objects on the basic 
screen

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

32 script parts objects on a called 
screen of the 1st layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: :

32 script parts objects on the called 
screens of the 16th layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

Superimpose window 2

Screen script

Basic screen 1 → 2 → ...

256

Called screen of the 1st layer 1 → 2 → ...

: :

Called screen of the 16th layer 1 → 2 → ...

Script part

32 script parts objects on the basic 
screen

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

32 script parts objects on a called 
screen of the 1st layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: :

32 script parts objects on the called 
screens of the 16th layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

Overlap window 1

Screen script

Basic screen 1 → 2 → ...

256

Called screen of the 1st layer 1 → 2 → ...

: :

Called screen of the 16th layer 1 → 2 → ...

Script part

32 script parts objects on the basic 
screen

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

32 script parts objects on a called 
screen of the 1st layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: :

32 script parts objects on the called 
screens of the 16th layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: : : : :

Priority order of screens Priority order of scripts Hierarchical order of the set overlay 
screen function

Execution order specified on GT 
Designer3

Number of 
executable 

scripts
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(4) Execution status
A project script, a screen script, or the script of a script parts object is processed according to the script execution status.

■3 Monitoring time for a project script, screen script, or script part
Specify the monitoring time of a script with GS385.
If a script does not end after a lapse of the specified monitoring time, the script is aborted.
The setting range is 1 second to 300 seconds. (Units of 1 second)
If the set value falls outside this range, 10 seconds are assumed.
If error code 15 is output during script execution, specify a longer monitoring time with GS385.

Overlap window 5

Screen script

Basic screen 1 → 2 → ...

256

Called screen of the 1st layer 1 → 2 → ...

: :

Called screen of the 16th layer 1 → 2 → ...

Script part

32 script parts objects on the basic 
screen

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

32 script parts objects on a called 
screen of the 1st layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

: :

32 script parts objects on the called 
screens of the 16th layer

Script parts object 1: 1 → 2 → ...
:
Script parts object 32: 1 → 2 → ...

Priority order of screens Priority order of scripts Hierarchical order of the set overlay 
screen function

Execution order specified on GT 
Designer3

Number of 
executable 

scripts

Script execution status Processing

Waiting for turn
• Waits for the processing turn according to the execution order.
• When the turn has come, the script enters the "Waiting for execution" status.

Waiting for execution

• The processing differs depending on the operating condition.
Satisfied: The script enters the "Execution" status.
Not satisfied: The script enters the "Waiting for turn" status, and the next script enters the "Waiting for 
execution" status.

Execution

• When the script has ended, the processing result is written to the PLC CPU and the script enters the "Waiting 
for turn" status.
The next script enters the "Waiting for execution" status.

• If an error occurs, the script enters the "Stop" status and the next script enters the "Waiting for execution" 
status.

• When a screen is switched while screen scripts are used, the next script does not enter the "Waiting for 
execution" status until all the scripts set in the screen have been executed.

Stop • The "Stop" status is held until the error history is cleared.
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■4 Running a project script, screen script, or script of a script parts object upon an applicable 
process

Use GS386 to set whether to run a script upon screen switching or other applicable processes.
When GS386 stores 0: Runs the script upon an applicable process.
When GS386 stores a nonzero value: Does not run the script upon an applicable process.
This setting is applied to the project scripts, screen scripts, and script parts where the following trigger types are set.

Example) When a screen script ([Trigger Type]: [Rise], [Trigger Device]: X1000) is set for base screen 2

The following shows the processes upon which a script runs.

*1 When [Perform script initial operation (screen/object) only when switching screens] is deselected on the [Option] tab in the 
[Script] dialog, the script runs upon the process.

➟9.9.5 ■4 [Option] tab

Trigger type When running a script upon an applicable process

[Rise] When the trigger device is on, the script runs upon screen switching or other applicable processes.

[Fall] When the trigger device is off, the script runs upon screen switching or other applicable processes.

[Rise/Fall] When the trigger device is on or off, the script runs upon screen switching or other applicable 
processes.

Script type Process Remarks

Project script When the GOT is powered on or when the GOT 
returns from offline -

Screen script
Script part

Screen switching The scripts, which are set for the screen displayed after screen 
switching, are executed.

Security switching *1 -

Language switching *1 -

System language switching *1 -

Station No. switching *1
When the station No. switching devices are set by screen type, the 
scripts that are set for the screens of the target screen type are 
executed.

Offset switching *1
On a screen having a script setting, when offset switching occurs in any 
device of the screen, the script is executed.

Buffer memory unit No. switching *1 -

When object script "redraw_screen()" is executed *1 -

ON

OFF

1 2

Trigger device
(X1000)

Screen switching device 
(for base screens)

Screen switching

When GS386 stores 0, the script runs.
When GS386 stores a nonzero value, the script does not run.
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9.9.4 Examples of project scripts, screen scripts, and the scripts of script parts 
objects

The following shows the examples of project scripts, screen scripts, and the scripts of script parts objects.

■1 Switches with the interlock function

(1) Operation
When the ready switch and the run/stop switch turn on, the running lamp turns on.
The system operation is controlled associating with the running lamp.

(2) Monitor screen setting

(3) Program example

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen image Operation of each object

Running lamp: 
Displays the operation status of the system. 
Ready switch: 
Operates as an interlock of the run/stop switch. 
Run/Stop switch: 
Switches the operation status of the system (running or stop).

Object name Type Setting item Setting

Running lamp Bit lamp Monitor device M0003 
(System operation control device)

Ready switch Bit switch
Monitor device M0001

Operation setting Bit set

Run/Stop switch Bit switch
Monitor device M0002

Operation setting Bit set

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if ([b:M0001]&&[b:M0002]){ 
set([b:M0003]);  
}else{ 
rst([b:M0003]); 
rst([b:M0002]); 
}

//When both the ready switch and the run/stop switch turn on, 
//the running lamp turns on and the system operation starts. 
//If not, 
//the running lamp turns off and the system stops and 
//the run/stop switch is reset.
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■2 Lamps which change display objects according to multiple conditions

(1) Operation
The operations of three lines are controlled by the switches, and the control statuses of each line are indicated by one 
lamp.

(2) Monitor screen setting

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen image Operation of each object

Control status lamp: 
The lamp color and the comment change according to the operation 
status of each line. 
Line 1 to Line 3 switch: 
Control the operations of line 1 to line 3. 
Stop all lines switch: 
Stops all the lines.

Object name Type Setting item Setting

Control status lamp Word lamp Monitor device D10

Control status lamp Word lamp Style, text

Display range: $V==0
Lamp color: 182
Text: All lines stop

Display range: $V==1
Lamp color: 3
Text: Line 1 running

Display range: $V==2
Lamp color: 224
Text: Line 2 running

Display range: $V==3
Lamp color: 227
Text: Line 3 running

Display range: $V==4
Lamp color: 28
Text: Line1 and 2 running

Display range: $V==5
Lamp color: 31
Text: Line1 and 3 running

Display range: $V==6
Lamp color: 252
Text: Line2 and 3 running

Display range: $V==7
Lamp color: 162
Text: Line1, 2 and 3 running

Line 1 switch Bit switch
Monitor device X1

Operation setting Bit alternate

Line 2 switch Bit switch
Monitor device X2

Operation setting Bit alternate

Line 3 switch Bit switch
Monitor device X3

Operation setting Bit alternate

Stop all lines switch Bit switch
Monitor device X0

Operation setting Bit set
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(3) Program example

■3 Password entry screen with time limit function

(1) Operation
The password entry screen is displayed. If the correct password is not entered within 10 seconds, the screen returns to 
the previous screen.

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if(([b:X1]==OFF)&&([b:X2]==OFF)&&([b:X3]==OFF)){ 
[w:D10]=0;  
} 
if(([b:X1]==ON)&&([b:X2]==OFF)&&([b:X3]==OFF)){ 
[w:D10]=1;  
} 
if(([b:X1]==OFF)&&([b:X2]==ON)&&([b:X3]==OFF)){ 
[w:D10]=2;  
} 
if(([b:X1]==OFF)&&([b:X2]==OFF)&&([b:X3]==ON)){ 
[w:D10]=3;  
} 
if(([b:X1]==ON)&&([b:X2]==ON)&&([b:X3]==OFF)){ 
[w:D10]=4;  
} 
if(([b:X1]==ON)&&([b:X2]==OFF)&&([b:X3]==ON)){ 
[w:D10]=5;  
} 
if(([b:X1]==OFF)&&([b:X2]==ON)&&([b:X3]==ON)){ 
[w:D10]=6;  
} 
if(([b:X1]==ON)&&([b:X2]==ON)&&([b:X3]==ON)){ 
[w:D10]=7;  
} 
if ([b:X0]==ON){  
rst([b:X1]);  
rst([b:X2]);  
rst([b:X3]);  
rst([b:X0]);  
}

//When line 1, 2, and 3 are off, 
//0 is stored in D10. 
//When line 1 is on and line 2 and 3 are off, 
//1 is stored in D10. 
//When line 2 is on and line 1 and 3 are off, 
//2 is stored in D10. 
//When line 3 is on and line 1 and 2 are off, 
//3 is stored in D10. 
//When line 1 and 2 are on and line 3 is off, 
//4 is stored in D10. 
//When line 1 and 3 are on and line 2 is off, 
//5 is stored in D10. 
//When line 2 and 3 are on and line 1 is off, 
//6 is stored in D10. 
//When line 1, 2, and 3 are on, 
//7 is stored in D10. 
//When the Stop all lines switch is turned on, 
//line 1 is turned off. 
//line 2 is turned off. 
//line 3 is turned off. 
//The Stop all lines switch is turned off.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen image Operation of each object

Manager button: 
Displays the password entry screen (base screen 4). 
Password entry: 
Displays the password entered using 0 to 9 switches. 
0 to 9 switch: 
Inputs a value. 
Clear switch: 
Clears the input value. 
Confirm switch: 
Confirms the input value.

Screen change Returns in 10 seconds

Manager screen (base screen 5) appears.

Screen with the switch (base screen 3)Manager

Password match
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(2) Monitor screen setting

(3) Program example
This program example uses the GOT special registers (GS devices).
In the GOT special registers, the GOT internal information, the communication status, and the error information of the 
scripts are stored.
Associating the GOT special registers with scripts enables various operations.
For the details of the GOT special register, refer to the following.

➟12.1.3 GOT special register (GS)

Object name Type Setting item Setting

Manager button Go To Screen switch Operation setting Base screen switching 4

Password entry Numerical input Monitor device D10

1 switch Key code switch Operation setting Key code [0031h]

2 switch Key code switch Operation setting Key code [0032h]

3 switch Key code switch Operation setting Key code [0033h]

4 switch Key code switch Operation setting Key code [0034h]

5 switch Key code switch Operation setting Key code [0035h]

6 switch Key code switch Operation setting Key code [0036h]

7 switch Key code switch Operation setting Key code [0037h]

8 switch Key code switch Operation setting Key code [0038h]

9 switch Key code switch Operation setting Key code [0039h]

0 switch Key code switch Operation setting Key code [0030h]

Clear switch Key code switch Operation setting Key code [0088h]

Confirm switch Key code switch Operation setting Key code [000Dh]

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if([b:GS1.01]==ON){ 
[w:TMP0001]=[w:GS7]; 
} 
if([w:D10]==3238){ 
[w:D0]=5; [w:D10]=0; }if([w:GS7]-[w:TMP0001]>=10){ 
[w:D0]=3; }

//Only when the screen switches to the password entry screen, 
//TMP0001 is input to GS7. 
//When the correct password is entered, 
//the manager screen (base screen 5) appears. 
//Clear password 
//When 10 seconds or longer have passed after the password 
entry screen appears, 
//the screen with the manager switch (base screen 3) appears.
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■4 GOT operation check (watchdog) on a PLC

Write data from the GOT to device [D200] of the PLC at regular intervals.
This enables the PLC to check whether the GOT is operating normally.
For example, if you configure a setting so that the indicator light is lit on the GOT screen when the value in [D200] does not 
change, the GOT visually notifies that it operates abnormally.

(1) Devices and ladder diagrams of the PLC
The following shows the devices and the ladder diagrams to be used in the PLC.

(2) Program examples

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Description Device

Write destination device from GOT D200

Written device from the GOT change 
confirmation device D201

Timeout timer T100

Processing start trigger M100

SM400 

T100 M100 

= D200 D201 OUT T100 K50 

MOV D200 D201 

Item Description

Trigger type Cycle (1 second)

Script [u16:D200] = [u16:D200] + 1;
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■5 Selecting data and swapping between upper and lower data

The GOT selects higher-order bits or lower-order bits of 16 or 32 bit data or swap the data.
The following shows program examples and the results using scripts.
Trigger types are user-selected.

(1) Selecting higher-order bits of 8 bit data
The GOT selects the higher-order 8 bits of the 16 bit data stored in [D300] and stores the data in [D350].

(2) Selecting lower-order bits of 8 bit data
The GOT selects the lower-order 8 bits of the 16-bit data stored in [D300] and stores the data in [D351].

(3) Swapping data between higher-order bits and lower-order bits of 16 bit data
The GOT swaps data between higher-order bits of 8 bits and lower-order bits of 8 bits of 16 bit data stored in [D300] and 
stores in [D352].

(4) Swapping data between higher-order bits and lower-order bits of 32 bit data
The GOT swaps data between higher-order bits of 16 bits and lower-order bits of 16 bits of the 32-bit data stored in [D400] 
and stores the data in [D450].

Specify [u16] or [u32] so that the data type is unsigned.
Specify the unsigned data type for a script when specifying [w].

The examples of the result using a script

[u16:D350] = ([u16:D300] & 0xFF00) >> 8;

[u16:D351] = [u16:D300] & 0x00FF;

[u16:D352] = (([u16:D300] & 0x00FF) << 8) | (([u16:D300] & 0xFF00) >> 8);

[u32:D450] = (([u32:D400] & 0x0000FFFF) << 16) | (([u32:D400] & 0xFFFF0000) >> 16);

Description Device Example of stored data

16-bit source data storage destination device D300 0x1234

(1) Higher-order bit data storage destination device D350 0x12

(2) Lower-order bit data storage destination device D351 0x34

(3) Higher/lower bit data swap storage destination device D352 0x3412

32-bit source data storage destination device D400 0x12345678

(4) Higher/lower bit data swap storage destination device D450 0x56781234

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■6 Data type conversion

Convert decimal data into BCD data or BCD data into decimal.
The following shows program examples and the results using a script.
Trigger types are user-selected.

(1) Converting decimal data into BCD data
The GOT converts decimal data stored in [D300] into BCD data and stores the data in [D350].

If 5 digits of data or more is stored in [D300], set the storage destination to 32 bits instead of using an if statement like 
the following.

(2) Converting BCD data into decimal data
The GOT converts BCD data in [D400] into decimal data and stores the data in [D450].

The examples of the result using a script

■7 Application examples of the file operation function

The following shows application examples of the file operation function.

(1) File name obtaining function (file_getlist)
Example) To obtain the file names of the two DAT files after the fourth DAT file in the folder Package 1 of drive A and to 
store eight characters of each file name in D100 and the subsequent devices

if( [u16:D300] < 10000 ) {
    [d16:D350] = [u16:D300];
}

[d32:D350] = [u16:D300];

[[u16:D450] = [d16:D400];

Description Device Example of stored data

Decimal data storage destination device D300 1234

(1) Converted BCD data storage device D350 0x1234

BCD data storage destination device D400 0x1234

(2) Converted decimal data storage device D450 1234

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

(Without using the declare function, #pragma use_character_code unicode)
[s16:D500] = file_getlist("A:\\Package1\\", "*.DAT", [w:D100], 3, 2, 8); //Obtain a file name

Package1

ARP00001.CSV
ARP00002.CSV
ARP00003.CSV
ARP00004.CSV
ARP00005.CSV
ARP00001.DAT
ARP00002.DAT
ARP00003.DAT
ARP00004.DAT
ARP00005.DAT

Drive A

D100 R A
D101 0 P
D102 0 0
D103 4 0
D104 \0 \0
D105 R A
D106 0 P
D107 0 0
D108 5 0
D109 \0 \0

Storage device
Obtains eight characters 
of the file names of the 
two DAT files after the 
fourth DAT file to store 
them in D100 and the 
subsequent devices.
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(2) Obtain folder name function (file_getfolderlist)
Example) To obtain 8 characters of the name of the 7th and 8th folders each in the Package1 folder in drive A, and store 
the characters in D100 and subsequent devices

(3) File read function (file_read)
Example) To read 16 bytes after the fifth byte of ARP00001.DAT in the folder Package 1 of drive A and to store the bytes 
in D100 and the subsequent devices

(Without using the declare function, #pragma use_character_code unicode)
[s16:D500] = file_getfolderlist("A:\\Package1\\", "",[w:D100],6,2,8); // Obtain a folder name.

Package1

Drive A

D100 e R
D101 i c
D102 e p
D103 2 0
D104 \0 \0
D105 e R
D106 i c
D107 e p
D108 3 0
D109 \0 \0

Storage device

Obtaining 8 characters of the name of 
the 7th and 8th folders each, and 
storing the characters in D100 and 
subsequent devices

Alarm01
Alarm02
Alarm03
Alarm04
Alarm05
Recipe01
Recipe02
Recipe03
Recipe04
Recipe05

[s16:D500] = file_read("A:\\Package1\\", "ARP00001.DAT", [w:D100], 4, 16); //Reads file

Package1

Drive A

D100 7 0
D101 2 1
D102 1 1
D103 5 1
D104 0 2
D105 2 3
D106 b a
D107 d c

Storage device

0    0    0    0

0    7    1    2

1    1    1    5

2    0    3    2

a    b    c    d

e    f    g    h

APR00001.DAT
…

Reads 16 bytes after the fifth byte 
of ARP00001.DAT to store the bytes 
in D100 and the subsequent devices.
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(4) File line read function (file_lineread, file_unilineread)
Example) To read the first line of ARP00001.CSV in the folder Package 1 of drive A and to store it in D300 and the 
subsequent devices
• Length of one line: Up to 32 bytes
• D200: Return value (number of read bytes)
• D300: Device storing the read data

By adding the number of read bytes stored in the return value to the offset, the second or later lines can be read 
consecutively.
Example)

(5) File write function (file_write)
Example) To overwrite the bytes after the fourth byte of ARP00001.DAT in the folder Package 1 of drive A with 16 bytes 
of the device value stored in D100 and the subsequent devices

[s16:D200] = file_lineread("A:\\Package1\\","ARP00001.CSV",[w:D300],0,32); //Read one line

[s16:D400] = [s16:D400] + [s16:D200]; //Add the number of read bytes to the offset
[s16:D200] = file_lineread("A:\\Package1\\","ARP00001.CSV",[w:D300],[s16:D400],256);

Package1

Drive A

D300 , 1
D301 3 1
D302 , 0
D303 1 2

D314 5
D315 5 6

Storage device

1,130 , 21 , … , 565 

APR00001.CSV

…

2,125 , 51 , … , 761
3,152 , 31 , … , 225

Maximum of 32 bytes

…

,

Reads the first line 
through to the line feed, 
and stores it in D300 
and the subsequent 
devices.

[s16:D500] = file_write("A:\\Package1\\", "ARP00001.DAT", [w:D100], 4, 16, 2); //Write file

Package1

Drive A

ARP00001.DAT
7 0
2 1
1 1
5 1
0 2
2 3
b a

D100
D101
D102
D103
D104
D105
D106
D107
D108
D109

d c
0 0
0 0… … …

Storage device

0    7    1    2

0    0    0    0

1    1    1    5

2    0    3    2

a    b    c    d

Overwrites the bytes after 
the fourth byte of 
"ARP00001.DAT" with 16 bytes 
of the device value stored in D100 
and the subsequent devices.
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(6) File rename function (file_rename)
Example) To rename ARP00001.DAT in the folder Package 1 of drive A to DATA1201.DAT

(7) File copy function (file_copy)
Example) To copy ARP00001.DAT in the folder Package1 of drive A to the backup folder of drive B

[s16:D500] = file_rename("A:\\Package1\\", "ARP00001.DAT", "DATA1201.DAT"); //Rename file

ARP00001.DAT
DATA1201.DAT

Drive A
Package1

A:\\Package1\\ARP00001.DAT DATA1201.DAT

<new file name><file name><folder name>

Renames the part <file name> of the file
specified with <folder name> and <file name>
to <new file name>.

[s16:D500] = file_copy("A:\\Package1\\", "ARP00001.DAT", "B:\\backup\\", "", 1); //Copy file.

ARP00001.DAT

Drive A
Package1

ARP00001.DAT

Drive B
backup

Copies the file specified by <copy source folder name> 
and <copy source file name> into the folder
specified by <copy destination folder name>.
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(8) Folder copy function (file_xcopy)
Example) To copy the data (including subfolder) in the folder Package 1 of drive A to the backup folder of drive B

(9) Folder and file name character number specification functions (#pragma folder_name_length, 
#pragma file_name_length)
Example) To limit the folder name to 14 characters and file name to 12 characters at file reading
GD2000 to GD2006: Store folder name A: \FOLDER0001\.
GD2100 to GD2105: Store file name ARP00001.DAT.
GD3000 to GD3015: Store the data read from a file.

[s16:D500] = file_xcopy("A:\\Package1\\", "sample1", "B:\\backup\\", "sample1", 1); //Copy folder.

Package1

sample 1

ARP00001.DAT

Drive A

backup

sample 1

ARP00001.DAT

Drive B

Copies the data (including subfolder) in the folders 
specified by <copy source folder name 1> 
and <copy source folder name 2> to the folders 
specified by <copy destination folder name 1>
 and <copy destination folder name 2>.

#pragma folder_name_length(14) //Limit the folder name length to 14 characters
#pragma file_name_length(12) //Limit the file name length to 12 characters
[s16:D500]=file_read([w:GD2000],[w:GD2100],[w:GD3000],0,32);//Read 32 characters from the start of file name GD2100

A:\FOLDER0001\

ARP00001.DAT

A : \ F O L D E R 0 0 0 1 \ …

A R P 0 0 0 0 1 . D A T…

Specifies the 14 characters 
extending from GD2000 as a folder name.

Specifies the 12 characters
extending from GD2100 as a file name.
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(10)Use Unicode declare function (#pragma use_character_code unicode)
Example) To specify a folder name and a file name in Unicode at file reading

■8 Application examples of the string operation function

The following shows application examples of the string operation function.

(1) String input function (str_scanf, str_uniscanf)
Example) To read the first two fields from one line stored in D100 and the subsequent devices
• D500: Return value
• D100: Input string storage device (read one-line data)
• D200: Input value storage device (first field)
• D204: Input value storage device (second field)

#pragma use_character_code unicode
[s16:D500] = file_getlist("A:\\Package1\\","*.DAT", [w:D100], 3, 2, 8); //Obtain a file name

Package1

ARP00001.CSV
ARP00002.CSV
ARP00003.CSV
ARP00004.CSV
ARP00005.CSV
ARP00001.DAT
ARP00002.DAT
ARP00003.DAT
ARP00004.DAT
ARP00005.DAT

Drive A

A
R
P
0
0
0
0
4
\0
A

Storage device

Obtains eight characters of 
the file names of the two DAT 
files after the fourth DAT file 
to store them in D100 and 
the subsequent devices.

D100
D101
D102
D103
D104
D105
D106
D107
D108
D109
D110
D111
D112
D113
D114
D115
D116
D117

R
P
0
0
0
0
5
\0

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[s16:D500] = str_scanf([w:D100], 32, 0, "%d,%4x", [w:D200], [w:D204]); //Obtain two data sets

D100 to D115: Source character string

Reads the value 
as a decimal number.

Reads the value as a hexadecimal
number consisting of up to 4 digits.

%d D200 1

%4x

1 , 1 0 0 0 , 1 5 7 4 , … , 4 2 4

(Signed BIN 16)

(Signed BIN 16)

, Skips the comma.
D204 4096
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(2) String output function (str_printf, str_uniprintf)
Example) To write three data sets stored in D200, D300, and D400 to one character string stored in D100 and the 
subsequent devices
• D500: Return value
• D100: Output string storage device (target character string)
• D200: Output value storage device (data to be written to the first field)
• D300: Output value storage device (data to be written to the second field)
• D400: Output value storage device (data to be written to the third field)

(3) String length acquisition function (str_strlen, str_unistrlen)
Example) To obtain the data length of characters from the 1st byte of D100 to the 10th byte
• D500: Return value (data length)
• D100: Input string storage device

(4) Partial string acquisition function (str_strmid, str_unistrmid)
Example) To read 7 bytes after the fifth character of the string stored in D100 and the subsequent devices and to store 
the bytes in D200
• D500: Return value (read data amount)
• D100: Input string storage device (source character string)
• D200: Output string storage device (read data)

[s16:D500] = str_printf([w:D100],18,"%04d,%4x,%4.2f\r\n",[s16:D200],[s16:D300],[flt:D400]); //Write three data sets

D100 to D108: Target character string

Pads with 0 and writes the device value
 of D200 as a 4-digit decimal number.

Writes the device value of D300 
as a hexadecimal number aligning left.

(Signed BIN 16)

(Signed BIN 16)

(Real number)

Writes the device value of D400
as a real number to two digits 
to the right of the decimal.
Writes the return codes.

0 0 1 0 , 4 d 2 , 3 . 1 4

D200 10

D400 3.14151

D300 1234

C
R

L
F

%04d

%4x

\r\n

%4.2f

[s16:D500] = str_strlen([w:D100],10); //Obtain data length of D100

D100 to D104: 10 bytes of the character string
Obtains the stored data length.

Stores the obtained data length to the return value.

The data length is 6 digits.

D500 6Null1 1 2 5 6 7

[s16:D500] = str_strmid([w:D100], [w:D200], 5, 7); //Obtain a part of the string of D100.

D100 to D108: Character string D200

Writes NULL at the end.
Reads 7 bytes after the fifth character of the character string.

D203

0 0 1 0 , D A T A 1 0 0 4 d 2 0 1 0 D A T A 1 0 0
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(5) Convert character code function (Local code to Unicode) (str_lc2uni)
Example) To read 6 characters (6-byte data) from an ASCII string in D100 and subsequent devices, encode the 
characters to Unicode, and write the 6 Unicode characters (12-byte data) to D200 and subsequent devices
• Order of storing data: Lower to higher

(6) Convert character code function (Unicode to local code) (str_uni2lc)
Example) To read 6 characters (12-byte data) from a Unicode string in D100 and subsequent devices, encode the 
characters to ASCII, and writes the 6 ASCII characters (6-byte data) to D200 and subsequent devices
• Order of storing data: Lower to higher

[s16:D500] = str_lc2uni(2, [w:D100], [w:D200], 6, 12); // Convert a character code.

D100 D

D101

D102

D205

A

TA

1\0

D200 D

D201

D202

D203

D204 1

A

A

T

\0

[s16:D500] = str_uni2lc(2, [w:D100], [w:D200], 12, 6); // Convert a character code.

D105

D100

D101

D102

D103

D104

D200

D201

D202

D

1

A

A

T

\0

DA

TA

1\0
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9.9.5 [Script] dialog

This dialog is used for setting a project script or screen script.
To display this dialog, select [Common] → [Script] → [Script] from the menu.

➟■1 [Project] tab
■2 [Screen] tab
■3 [Script Symbol] tab
■4 [Option] tab

■1 [Project] tab

Set the project scripts which operate to the whole project.

1) Script setting list
Displays the list of script settings.
The script of the selected script No. is displayed in the space below the script setting list.

2) Script preview
Displays the content of the script selected in the script setting list.

3) [Add] button
Add a new script setting to the list.
Click this button to display the [Script Edit] dialog.

➟9.9.6 [Script Edit] dialog (for project scripts and screen scripts)
The execution order of the scripts is set according to the order in which the scripts are added.

4) [Edit] button
Edit the selected script setting.
Click this button to display the [Script Edit] dialog.

➟9.9.6 [Script Edit] dialog (for project scripts and screen scripts)
5) [Copy] button

Copies the selected script setting.
6) [Paste] button

Pastes the copied script setting to the last line of the list.
Click the [Paste] button to display the dialog for selecting the method to paste the script.
The pasting method differs depending on the [Yes] or [No] button.
[Yes] button: Copies the source script.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Select the [Yes] button to display the following dialog.

[No] button: Refers to the same script as that of the copy source.
7) [Delete] button

Deletes the selected script setting.
8) [Up] button, [Down] button

Changes the execution order of the selected script setting.
9) [Edit Script] button

Edit the selected project script with the editor selected in [Script Editor Selection] in the [Option] tab.
➟[Option] tab: ■4 [Option] tab
Script editor: 9.9.7 [Edit Script(script name)] dialog

10) [Script List] button
Displays the list of the registered scripts.
You can register scripts additionally and edit the scripts in the list.

➟9.9.8 [Script File List] dialog

■2 [Screen] tab

1) [Screen Type]
Select the screen ([Base] or [Windows]) in which the script setting operates and the screen number.
The setting range is [0] to [32767].
The screen number can be selected with the screen title.
Click the [Browse] button to display the [Screen Image List] dialog.

➟2.5 Creating, Opening, and Closing a Screen

• [Script No.]
Set the script No. for the script to be registered. (Default: The 
minimum number of the non-registered script No.) After registered, 
the script is reflected to the script list.

➟9.9.8 [Script File List] dialog
• [File Name]

This item is displayed when [External File (External Data)] is 
selected in the [Option] tab.
Click the [Browse] button to set the path name and file name of the 
script to be registered.

• [Script Name]
This item is displayed when [Project Data (Internal Data)] is 
selected in the [Option] tab.
Set the name of the script to be registered.
The setting range is 1 character to 32 characters.When [Project Data (Internal Data)] is selected 

in the [Option] tab

When [External File (External Data)] is selected 
in the [Option] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2) Script setting list
Displays the list of script settings.
The script of the selected script No. is displayed in the space below the script setting list.

3) Script preview
Displays the content of the script selected in the script setting list.

4) [Add] button
Add a new script setting to the list.
Click this button to display the [Script Edit] dialog.

➟9.9.6 [Script Edit] dialog (for project scripts and screen scripts)
The execution order of the scripts is set according to the order in which the scripts are added.

5) [Edit] button
Edit the selected script setting.
Click this button to display the [Script Edit] dialog.

➟9.9.6 [Script Edit] dialog (for project scripts and screen scripts)
6) [Copy] button

Copies the selected script setting.
7) [Paste] button

Pastes the copied script setting to the last line of the list.
Click the [Paste] button to display the dialog for selecting the method to paste the script.
The pasting method differs depending on the [Yes] or [No] button.
[Yes] button: Copies the source script.
Select the [Yes] button to display the following dialog.

[No] button: Refers to the same script as that of the copy source.
8) [Delete] button

Deletes the selected script setting.
9) [Up] button, [Down] button

Changes the execution order of the selected script setting.
10) [Edit Script] button

Edit the selected project script with the editor selected in [Script Editor Selection] in the [Option] tab.
➟[Option] tab: ■4 [Option] tab
Script editor: 9.9.7 [Edit Script(script name)] dialog

11) [Script List] button
Displays the list of the registered scripts.
You can register scripts additionally and edit the scripts in the list.

➟9.9.8 [Script File List] dialog

• [Script No.]
Set the script No. for the script to be registered. (Default: The 
minimum number of the non-registered script No.) After registered, 
the script is reflected to the script list.

➟9.9.8 [Script File List] dialog
• [File Name]

This item is displayed when [External File (External Data)] is 
selected in the [Option] tab.
Click the [Browse] button to set the path name and file name of the 
script to be registered.

• [Script Name]
This item is displayed when [Project Data (Internal Data)] is 
selected in the [Option] tab.
Set the name of the script to be registered.
The setting range is 1 character to 32 characters.When [Project Data (Internal Data)] is selected

in the [Option] tab

When [External File (External Data)] is selected
in the [Option] tab
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■3 [Script Symbol] tab

Register character strings as script symbols.
Devices and constants in a script can be substituted by the registered character strings.
The set script symbols are usable in project scripts and screen scripts.

1) [Add] button
This button is available when [Skip blank rows] is selected.
Displays the [Add Script Symbol] dialog.

2) [Copy] button
Copies the setting from the row selected in the script symbol list.
You can copy the settings from multiple rows at one time.
When [Skip blank rows] is selected, the settings in the hidden rows are also copied.
The copied settings can be pasted to another script symbol setting dialog.

• [No.]
Set a number for the script symbol to be added.
The setting range is [1] to [10000].

• [Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

• [Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Paste] button
Pastes the copied setting to the selected row.
When [Skip blank rows] is selected, the [Paste Symbol] dialog is displayed.

4) [Delete] button
Deletes the setting from the selected row.
You can delete the settings from multiple rows at one time.

5) [Import] button
Displays the [Open] dialog.
Read the script symbol settings from a Unicode text file or CSV file.

6) [Export] button
Displays the [Save As] dialog.
Save the script symbol settings to a Unicode text file or CSV file.
If multi-language characters are used in the settings, use the Unicode text file format.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

7) [Skip blank rows]
Displays only the rows in which script symbols have been registered.

8) Script symbol list
Lists the registered script symbols.
[Symbol Name] and [Device and Constant] are editable.

9) [Script List] button
Displays the [Script List] dialog.
The [Script List] dialog lists the registered scripts.
You can register scripts additionally and edit the scripts in the list.

➟9.9.8 [Script File List] dialog

• [Symbol No.]
Set a symbol number for the destination row.
The setting range is [1] to [10000].

• [First Symbol No.]
Set a symbol number for the first destination row.
The setting range is [1] to [10000].

Item Description

[No.]
Row number.
Clicking a row number selects the relevant row.

[Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

[Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

When pasting a setting to one row

When pasting settings to multiple rows
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(1) Editing method of scripts
You can edit scripts in the exported Unicode text file or CSV file using spreadsheet software and other 
software.
The edited Unicode text file or CSV file can be imported and read to GT Designer3.

(2) Editing the exported file
Example) When script settings are exported into and imported from a CSV file

When 0 is set at the beginning of the symbol name, device, or constant, 0 at the beginning may be 
deleted depending on the function of the application for editing files (spreadsheet software and other 
software).
Pay attention to the above for editing exported files.

Add settings using applications 
such as spreadsheet software.

The added settings are reflected.

Export the set script symbols to a CSV file.

Edit the exported file.

Import from the CSV file to GT Designer3.
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■4 [Option] tab

Set the storage location of script data, editor used for editing scripts, and processing when an internal device is used.

1) [Script Data Storage Destination]
Select the location to store the script data of project scripts and screen scripts.

*1 Up to 32 alphanumeric characters or symbols can be set for the script file name in the project data.
When the setting is changed from [External File (External Data)] to [Project Data (Internal Data)], the 33rd and later characters 
in the script file name are deleted.

2) [Script Editor Selection]
Set the editor for editing project scripts and screen scripts.

Item Description

[Project Data (Internal Data)]
Select this item to store the script data in the project data. 
When the setting is changed from [External File (External Data)] to [Project Data (Internal 
Data)], the script data is converted from the script file to the project data.

[External File (External Data)]

Select this item to store the script data in the script file. 
When the setting is changed from [Project Data (Internal Data)] to [External File (External 
Data)], the script data is converted from the project data to the script file. 
Select [External File (External Data)] in [Script Data Storage Destination] to display the 
following dialog.

• [Destination to create the script file]*1

Specify the folder to save the script file in.
Click the [OK] button to convert the script data to a script file.

[Display the script data update confirmation 
message when processing write to GOT]

This item can be selected when [Script Data Storage Destination] is set to [External File 
(External Data)]. 
Select this item to display the message to check whether to update the script data for 
communication with the GOT (when [Communication] is selected from the menu).

Item Description

[Editor Type]

[Script Editor]: Select this item to use the script editor built in GT Designer3. 
[User-specified Editor]: Select this item to use the text editor specified by the user. 
This item can be selected only when [Script Data Storage Destination] is set to [External 
File (External Data)]. 
When selecting [User-specified Editor], set [Editor Path] and [Option] below.

[Editor Path] Set the start-up file of the text editor (such as Notepad (NOTEPAD.EXE) or WordPad 
(WORDPAD.EXE) of Windows).

[Option] Specify the option for the text editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [File/Text Handling Function Storage Order]
Select the order of data storage when file_read or file_write is used.

• [Low-->High]: Select this item to store data in the order of lower to upper data.
• [High-->Low]: Select this item to store data in the order of upper to lower data.

4) [Script Data Update (Project, Screen)]
Click the [Update] button to update the setting of the script data read to GT Designer3.

5) [Perform script initial operation (screen/object) only when switching screens]
Enables the initial operation of the screen script or the object script upon screen switching only.
The screen scripts and object scripts, which the following trigger type is set in, are executed upon screen switching.

• [Rise]
Executes the script when the trigger device turns on after screen switching or other processes.

• [Fall]
Executes the script when the trigger device turns off after screen switching or other processes.

• [Rise/Fall]
Executes the script when the trigger device turns on or off after screen switching or other processes.

When the screen script ([Trigger Type]: [Rise], [Trigger Device]: X1000) is set for base screen 2
After base screen 1 is switched to base screen 2, if the trigger device (X1000) turns on, the screen script set for base 
screen 2 is executed.

The setting determines the process that triggers the initial operation of the script as shown below.

You can disable the initial operation of the scripts by using the GOT internal devices.
• Project script and screen script: GS386
• Object script: GS389

➟12.1.3 ■4 Read device list
6) [Script List] button

Displays the [Script List] dialog.
Displays the list of the registered scripts.
You can register scripts additionally and edit the scripts in the list.

➟9.9.8 [Script File List] dialog

Setting Process

Selected
• Screen switching

The scripts, which are set for the screen displayed after screen switching, are executed.

Cleared

• Screen switching
The scripts, which are set for the screen displayed after screen switching, are executed.

• Security switching
• Language switching
• System language switching
• Station No. switching

When the station No. switching devices are set by screen type, the scripts that are set for the screens of the target 
screen type are executed.

• Offset switching
Only the screen scripts are executed.
On a screen having a script setting, when offset switching occurs in any device of the screen, the script is 
executed.

• Buffer memory unit No. switching
• When object script "redraw_screen()" is executed

Screen switching

Trigger device
(X1000)

Screen Switching
device

The trigger conditions are satisfied, and the script is executed.

ON

OFF

1 2
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9.9.6 [Script Edit] dialog (for project scripts and screen scripts)

This dialog is used for setting a project script or screen script.
For each script setting, set a trigger condition and a script.

1) [Order]
Displays the execution order of the script being edited.

2) [Script No.]
Set the registration number of the script that is to be executed by the script being edited.
Click the [View] button to check the registration number of other scripts.

➟9.9.8 [Script File List] dialog
3) [File Name]

Displays the drive and folder where the script file to be executed is stored when [External File (External Data))] is 
selected in the [Option] tab.
When no script file is registered, click the [Browse] button to set the script file to be executed.
Up to 32 characters can be set for the file name of the script file (excluding the extension.TXT).
When [Project Data (Internal Data)] is selected in the [Option] tab and the script data is converted, the file name is 
used for [Script Name].
When 32 or more characters are used for a file name, only the 32 characters are used for [Script Name] and the 33rd 
or later characters are not used.

4) [Script Name]
When [Project Data (Internal Data)] is selected in the [Option] tab, set the script name to be executed.
The following symbols cannot be entered into [Script Name].
/ \ ? * : | " < >
Click the [Import] button to read the script edited in the text file format to GT Designer3.
When a script file is imported, the file name excluding the extension (.TXT) is displayed at [Script Name].
Set [Script Name] which is different from that of other scripts.
When [External File (External Data)] is selected in the [Option] tab and the script data is converted, [Script Name] is 
used for the file name of the script file.
Therefore, when [Script Name] is duplicated, take a measure such as changing the file name.

5) [Edit Script] button
Edit the script selected in [File Name] or [Script Name] with the editor which is selected in [Script Editor Selection] in 
the [Option] tab.

➟[Option] tab: 9.9.5 ■4 [Option] tab
Script editor: 9.9.7 [Edit Script(script name)] dialog

6) [Comment]
Set the comment (note) of the script being edited.
Up to 32 characters can be set.

7) [Syntax Check] button
Checks the syntax of the script selected in [File Name] or [Script Name].
The available device type and device range are also checked.

➟9.9.14 ■2 Messages to be displayed at the syntax check
8) [Data Type]

Select the data type of the script to be executed.
The following shows the items to be selected.

• [Signed BIN16]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Project Data (Internal Data)] is selected
in the [Option] tab of the [Script] dialog

When [External File (External Data)] is selected
in the [Option] tab of the [Script] dialog
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• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

9) [Trigger Type], [Trigger Device]
Displays the operating condition and trigger device of the script which are set in the [Trigger Setting] dialog.

10) [Trigger Setting] button
Click the [Trigger Setting] button to display the [Trigger Setting] dialog.

➟6.2.2 Setting Trigger Types

11) [Include this script in a screen-related setting when utilizing project/screen]
This item is displayed only when this dialog has been brought up from the [Project] tab of the [Script] dialog.
Utilizes this script as a screen-related setting when the project or screen utilization is executed.

• [Trigger Type]
Select the operating condition of the script.
The following shows the items to be selected.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [When closing a screen] (Available to the screen script only)

• [Trigger Device]
Set this item when [Trigger Type] is set to [ON], [OFF], [Rise], [Fall], 
[Rise/Fall], [ON Sampling], or [OFF Sampling].
Set a trigger device to execute the script.

• [Unit]
Set this item when [Trigger Type] is set to [Sampling], [ON Sampling], 
or [OFF Sampling].
Select the unit of the cycle time to execute the script.
The following shows the items to be selected.
• [Second]
• [Millisecond (x100ms)]

• [Sampling]
Set this item when [Trigger Type] is set to [Sampling], [ON Sampling], 
or [OFF Sampling].
Set the cycle time to execute the script.
The setting range depends on the setting of [Unit].
When [Unit] is set to [Second], the setting range is [1] second to 
[3600] seconds.
When [Unit] is set to [Millisecond (x100ms)], the setting range is [1] × 
100 ms to [600] × 100 ms.
The counting of the cycle time starts when the trigger condition is 
satisfied.
When the satisfied trigger condition becomes unsatisfied, the count 
of the cycle time is reset.
Example) When [Trigger Type] is set to [ON Sampling] and the cycle 
time is set to 10 seconds
After the trigger device has been on for 10 seconds, the script runs.
If the trigger device turns off before a lapse of 10 seconds, the script 
does not run.

When [Trigger Type] is set to [Rise]

When [Trigger Type] is set to [Sampling]

When [Trigger Type] is set to [ON Sampling]

[Sampling]
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part

9 - 401



■1 Behavior of the script for which [Trigger Type] is set to [When closing a screen]
Such a script runs immediately before the relevant screen is switched or closed.
The screen will not be switched until the script execution is complete.
If an error or a timeout occurs during script execution, the screen is switched upon the occurrence of the event.
When [Trigger Type] is set to [When closing a screen], take the following precautions.

Item Description

Response speed for screen switching Depending on the controller device used in the script, there may be a delay in response when 
switching screens.

Restrictions during script execution

When a trigger type other than [When closing a screen] is set for a script, the script does not 
run if its trigger condition is satisfied during the execution of another script whose trigger type 
is [When closing a screen].
The GOT can accept inputs from a touch switch or others.

State of not notifying of an error An error is not notified in the state where the communication is unestablished for reasons 
including a cable disconnection or screen switching.
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9.9.7 [Edit Script(script name)] dialog

This dialog is used for setting a project script, screen script, script part, or object script.
Edit, import, or export a script.

1) [Undo] button
Returns the editing operation of the script to the previous step.

2) [Redo] button
Redoes the returned operation.

3) [Cut] button
Cuts the selected character strings.

4) [Copy] button
Copies the selected character strings.

5) [Paste] button
Pastes the copied or cut character strings.

6) [Delete] button
Deletes the selected character strings.

7) [Import] button
Displays the [Open] dialog.
Read a script from a text file.

8) [Export] button
Displays the [Save As] dialog.
Save the script in the script edit area to a text file.
If the script contains multi-language characters, use the Unicode text file format.
For the precautions for using a Unicode text file, refer to the following.

➟12.9 Precautions for Using Unicode Text File
9) [Search] button

Displays the [Search] dialog.
Input the text to be searched and select the search direction ([Up], [Down]). Then click the [Search Next] button to 
search the input text.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [External File (External Data)] is selected 
in the [Option] tab of the [Script] dialog
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10) [Symbol] button
Displays the dialog for selecting a script symbol to be inserted.
The script symbol is inserted into the cursor position in the script edit area.
The dialog to appear varies depending on the type of the script being edited.

11) [Input Navigation]
Displays [Input Navigation] in the dialog.

12) [Line No.]
Displays line numbers in the script edit area.

13) Script edit area
Area to edit a script.
The following editing operations are available.

• Cutting and pasting a selected string by drag and drop
• Copying and pasting a selected string by drag and drop while holding down the [Ctrl] key

14) [Input Navigation]
Insert a device or function to the script.
Select an item from the input navigation tree to display its expression in the input area.
Click the [Insert] button to insert the entry in the input area into the cursor position in the script edit area.

15) [Syntax Check] button
Checks the syntax of the script being edited.
The available device type and device range are also checked.

➟9.9.14 ■2 Messages to be displayed at the syntax check

Script Reference

Project script
➟9.9.9 [Script Symbol] dialog

Screen script

Script part ➟9.9.10 ■2 [Script Parts Symbol] tab

Object script ➟9.10.5 [Object Script Symbol] dialog

Item Description

Input navigation tree
Select a device or function to be inserted.
The expression of the selected item appears in the input area.

Input area Make an entry to be inserted to the script.

[Ref] button

This item appears when a device, label, or tag is selected in the input navigation tree.
Displays the setting dialog of the selected device, label, or tag.
The settings made in the dialog is reflected to the input area.
To display the [Select CH No.] dialog, hold down the [Shift] key and click the [Ref] button.
To specify a channel, label, or tag, bring up the relevant setting dialog from the [Select CH 
No.] dialog.

➟6.1.2 ■1 Setting devices in the device setting dialog

[Insert] button Inserts the entry in the input area into the cursor position in the script edit area.

[Description] Describes the expression and function of the item selected in the input navigation tree.

Input navigation tree Input area
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9.9.8 [Script File List] dialog

This dialog is used for setting a project script or screen script.
Select [Common] → [Script] → [Script File List] from the menu to display the setting dialog.
Register scripts additionally and edit the scripts in the list of the registered scripts.

1) Script list
Displays the list of the registered scripts (script file or script name, modified date, and comment).
For script files and script names, the path name is displayed when [External File (External Data)] is selected in the 
[Option] tab and the script name is displayed when [Project Data (Internal Data)] is selected in the [Option] tab.
Even if a script is set in the [Edit Script] dialog, the setting is applied to this dialog.
You can input the comment directly in the comment column in the list.
The content of the selected script is displayed in the space below the script setting list.

2) Script preview
Displays the content of the script selected in the script setting list.

3) [Edit Script] button
Edit the selected script with the script editor which is selected in [Script Editor Selection] in the [Option] tab or the editor 
specified by the user.
For the details of the [Option] tab and script editors, refer to the following.

➟[Option] tab: 9.9.5 ■4 [Option] tab
Script editor: 9.9.7 [Edit Script(script name)] dialog

4) [Copy] button
Copies the selected script.

5) [Paste] button
Pastes the copied script to the selected script No.

6) [Delete] button
Deletes the selected script.

7) [Browse] button
Register the script file to be referred to in the script list when [External File (External Data)] is selected in the [Option] 
tab.

8) [Import] button
Reads the script edited in the text file to GT Designer3 when [Project Data (Internal Data)] is selected in the [Option] 
tab.

9) [Convert Path] button
Changes the path name of the script file when [External File (External Data)] is selected in the [Option] tab.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When [Project Data (Internal Data)] is selected
in the [Option] tab of the [Script] dialog

When [External File (External Data)] is selected
in the [Option] tab of the [Script] dialog

4)
3)

5)

7)
6)

9)

10)

11) 11)

10)

4)
3)

5)

8)
6)

1) 1)

2) 2)

9)
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Select the row to be changed and click the [Convert Path] button to display the [Convert File Path] dialog.

When the script file is saved in the folder of the project data of GT Designer3, the path name of the script file is updated 
automatically even if the folder in the project data is moved to a different drive or path.
Thus, the path name does not have to be set again.

10) [Syntax Check] button, [Check All] button
Checks the script syntax of the selected script or all the registered scripts.
When an error occurs, the row number with an error and error details are displayed.
The available device type and device range are also checked.

➟9.9.14 ■2 Messages to be displayed at the syntax check
11) [Jump] button

Selects the script set in [Script No.].

9.9.9 [Script Symbol] dialog

This dialog is used for setting a project script or screen script.
Select [Common] → [Script] → [Script Symbol] from the menu to display the setting dialog.
Register character strings as script symbols.
Devices and constants in a script can be substituted by the registered character strings.
The set script symbols are usable in project scripts and screen scripts.

• [Script No.]
Script No. selected in the script list

• Previous value
Old path name of the script file

• [Before]
Click the [Browse] button to set a new path name of ;othe script file.

• [Convert the same path]
Select this item to convert all the files in the same path name as the 
file to be converted.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4) 5) 6)

7)

8)

9)
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1) [Add] button
This button is available when [Skip blank rows] is selected.
Displays the [Add Script Symbol] dialog.

2) [Copy] button
Copies the setting from the row selected in the script symbol list.
You can copy the settings from multiple rows at one time.
When [Skip blank rows] is selected, the settings in the hidden rows are also copied.
The copied settings can be pasted to another script symbol setting dialog.

3) [Paste] button
Pastes the copied setting to the selected row.
When [Skip blank rows] is selected, the [Paste Symbol] dialog is displayed.

4) [Delete] button
Deletes the setting from the selected row.
You can delete the settings from multiple rows at one time.

5) [Import] button
Displays the [Open] dialog.
Read the script symbol settings from a Unicode text file or CSV file.

6) [Export] button
Displays the [Save As] dialog.
Save the script symbol settings to a Unicode text file or CSV file.
If multi-language characters are used in the settings, use the Unicode text file format.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

7) [Skip blank rows]
Displays only the rows in which script symbols have been registered.

8) Script symbol list
Lists the registered script symbols.
[Symbol Name] and [Device and Constant] are editable.

• [No.]
Set a number for the script symbol to be added.
The setting range is [1] to [10000].

• [Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

• [Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

• [Symbol No.]
Set a symbol number for the destination row.
The setting range is [1] to [10000].

• [First Symbol No.]
Set a symbol number for the first destination row.
The setting range is [1] to [10000].

Item Description

[No.]
Row number.
Clicking a row number selects the relevant row.

When pasting a setting to one row

When pasting settings to multiple rows
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9) [Insert] button
This item appears when this dialog is brought up from the [Edit Script(script name)] dialog.
Inserts the selected script symbol into the script edit area in the [Edit Script(script name)] dialog.

(1) Editing method of scripts
You can edit scripts in the exported Unicode text file or CSV file using spreadsheet software and other 
software.
The edited Unicode text file or CSV file can be imported and read to GT Designer3.

(2) Editing the exported file
When 0 is set at the beginning of the symbol name, device, or constant, 0 at the beginning may be 
deleted depending on the function of the application for editing files (spreadsheet software and other 
software).
Example) When script settings are exported into and imported from a CSV file

[Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

[Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

Item Description
9 - 408 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

Pay attention to the above for editing exported files.

Export the set script symbols to a CSV file.

Edit the exported file.

Import from the CSV file to GT Designer3.

Add settings using applications
such as spreadsheet software.

The added settings are reflected.
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9.9.10 [Script Parts] dialog

This dialog is used for setting a script part.
Step 1 Select [Object] → [Script Parts] from the menu.
Step 2 Click the position to place a script parts object.
Step 3 Double-click the script parts object to display the setting dialog.

➟■1 [Script Setting] tab
■2 [Script Parts Symbol] tab

■1 [Script Setting] tab
Set a script trigger condition and a script.

1) Script setting list
Lists the scripts set for the current script parts object.

2) [Add] button
Displays the [Script Edit] dialog.
Add a new script setting to the list.

➟9.9.11 [Script Edit] dialog (for script parts)
3) [Edit] button

Displays the [Script Edit] dialog.
Edit the selected script setting.

➟9.9.11 [Script Edit] dialog (for script parts)
4) [Copy] button

Copies the selected script setting.
5) [Paste] button

Pastes the copied script setting to the last line of the list.
6) [Delete] button

Deletes the selected script setting.
7) [Up] button or [Down] button

Changes the execution order of the selected script setting.
8) Script preview

Displays a preview of the script set for the selected script setting.
9) [Edit Script] button

Displays the [Edit Script(script name)] dialog.
Edit the script.

➟9.9.7 [Edit Script(script name)] dialog
10) [Import] button

Displays the [Open] dialog.

1)

8)

13)

15)

2)
3)

4)
5)

6) 7)

9)
10)

11)

14)

12)
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Read a script from a text file.
The name of the read text file is set as the script name.

11) [Export] button
Displays the [Save As] dialog.
Save the previewed script to a text file.

12) [Syntax Check] button or [Check All] button
Performs a syntax check on the previewed script or all the scripts set for the script parts object.
If an error is detected, the relevant line number and error details are displayed.
The available device type and device range are also checked.

➟9.9.14 ■2 Messages to be displayed at the syntax check
13) [Layer]

Not available to GT21 and GS21.
Select the layer to arrange the object on.
The following shows the items to be selected.

• [Front]
• [Back]

14) [Category]
Select the category to assign the object.

➟11.7 Managing figures and objects by category
15) [Name]

Set the object name.
The name is displayed in the [Data View] window, property sheet, and others.
The name is changeable on the other tabs as well.
Up to 100 characters can be set.

■2 [Script Parts Symbol] tab
Register character strings as script parts symbols.
Devices and constants in a script can be substituted by the registered character strings.
The set script parts symbols are usable only in the scripts of the current script parts object.
Display the [Script Parts Symbol] dialog from the [Edit Script(script name)] dialog.

1) [Add] button
This button is available when [Skip blank rows] is selected.

1) 2) 3) 4) 5) 6)

7)

8)

1) 2) 3) 4) 5) 6)

7)

8)

9)
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Displays the [Add Script Parts Symbol] dialog.

2) [Copy] button
Copies the setting from the row selected in the script symbol list.
You can copy the settings from multiple rows at one time.
When [Skip blank rows] is selected, the settings in the hidden rows are also copied.
The copied settings can be pasted to another script symbol setting dialog.

3) [Paste] button
Pastes the copied setting to the selected row.
When [Skip blank rows] is selected, the [Paste Symbol] dialog is displayed.

4) [Delete] button
Deletes the setting from the selected row.
You can delete the settings from multiple rows at one time.

5) [Import] button
Displays the [Open] dialog.
Read the script symbol settings from a Unicode text file or CSV file.

6) [Export] button
Displays the [Save As] dialog.
Save the script symbol settings to a Unicode text file or CSV file.
If multi-language characters are used in the settings, use the Unicode text file format.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

7) [Skip blank rows]
Displays only the rows in which script symbols have been registered.

8) Script symbol list
Lists the registered script symbols.
[Symbol Name] and [Device and Constant] are editable.

• [No.]
Set a number for the script symbol to be added.
The setting range is [1] to [10000].

• [Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

• [Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

• [Symbol No.]
Set a symbol number for the destination row.
The setting range is [1] to [10000].

• [First Symbol No.]
Set a symbol number for the first destination row.
The setting range is [1] to [10000].

Item Description

[No.]
Row number.
Clicking a row number selects the relevant row.

[Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

When pasting a setting to one row

When pasting settings to multiple rows
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9) [Insert] button
Inserts the selected script symbol into the script edit area in the [Edit Script(script name)] dialog.

9.9.11 [Script Edit] dialog (for script parts)

This dialog is used for setting a script part.

1) [Order]
Execution order of the current script.

2) [Script Name]
Name of the current script.
The following symbols cannot be entered into [Script Name].
/ \ ? * : | " < >

3) [Import] button
Displays the [Open] dialog.
Read a script from a text file.
The name of the read text file is set as the script name.

4) [Edit Script] button
Displays the [Edit Script(script name)] dialog.
Edit the script.

➟9.9.7 [Edit Script(script name)] dialog
5) [Comment]

Set the comment (note) of the script being edited.
Up to 32 characters can be set.

6) [Syntax Check] button
Checks the syntax of the script for possible errors.
The available device type and device range are also checked.

➟9.9.14 ■2 Messages to be displayed at the syntax check
7) [Data Type]

Select the data type of the script to be executed.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

8) [Trigger Type] or [Trigger Device]
Displays the script trigger type or trigger device set in the [Trigger Setting] dialog.

9) [Trigger Setting] button

[Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

Item Description

1)
2) 4)
5) 6)
7)

8)
9)

3)
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part

9 - 413



Displays the [Trigger Setting] dialog.
Set a script trigger condition.

■1 Behavior of the script for which [Trigger Type] is set to [When closing a screen]
Such a script runs immediately before the relevant screen is switched or closed.
The screen will not be switched until the script execution is complete.
If an error or a timeout occurs during script execution, the screen is switched upon the occurrence of the event.
When [Trigger Type] is set to [When closing a screen], take the following precautions.

• [Trigger Type]
Select the operating condition of the script.
The following shows the items to be selected.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [When closing a screen]

• [Trigger Device]
Set this item when [Trigger Type] is set to [ON], [OFF], [Rise], [Fall], 
[Rise/Fall], [ON Sampling], or [OFF Sampling].
Set a trigger device to execute the script.

• [Unit]
Set this item when [Trigger Type] is set to [Sampling], [ON Sampling], 
or [OFF Sampling].
Select the unit of the cycle time to execute the script.
The following shows the items to be selected.
• [Second]
• [Millisecond (x100ms)]

• [Sampling]
Set this item when [Trigger Type] is set to [Sampling], [ON Sampling], 
or [OFF Sampling].
Set the cycle time to execute the script.
The setting range depends on the setting of [Unit].
When [Unit] is set to [Second], the setting range is [1] second to 
[3600] seconds.
When [Unit] is set to [Millisecond (x100ms)], the setting range is [1] × 
100 ms to [600] × 100 ms.
The counting of the cycle time starts when the trigger condition is 
satisfied.
When the satisfied trigger condition becomes unsatisfied, the count 
of the cycle time is reset.
Example) When [Trigger Type] is set to [ON Sampling] and the cycle 
time is set to 10 seconds
After the trigger device has been on for 10 seconds, the script runs.
If the trigger device turns off before a lapse of 10 seconds, the script 
does not run.

When [Trigger Type] is set to [Rise]

When [Trigger Type] is set to [Sampling]

When [Trigger Type] is set to [ON Sampling]

[Sampling]

Item Description

Response speed for screen switching Depending on the controller device used in the script, there may be a delay in response when 
switching screens.

Restrictions during script execution

When a trigger type other than [When closing a screen] is set for a script, the script does not 
run if its trigger condition is satisfied during the execution of another script whose trigger type 
is [When closing a screen].
The GOT can accept inputs from a touch switch or others.

State of not notifying of an error An error is not notified in the state where the communication is unestablished for reasons 
including a cable disconnection or screen switching.
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9.9.12 Precautions

■1 Precautions for use
(1) Applicable range of the scripts

Since this function is designed to control the GOT display, do not use it for machine control that requires precise time 
management.
When changing the data in PLC through the GOT, create an interlock circuit using a sequence program to ensure the 
whole system can always operate safely.
The following periods may vary depending on projects.
• The period between when the trigger device condition of the script is satisfied and when the script is actually executed
• Processing time of the script

(2) Stop of the script processing
In any of the following cases, the corresponding script being processed stops and an error occurs.
• In division, when the divisor becomes 0 and the calculation becomes zero division
• When [BCD16], [BCD32], or [BCD64] is selected as the script data type but a value of the monitor device cannot be 
handled as BCD

• When [BCD16], [BCD32], or [BCD64] is selected as the script data type but the operation result is out of the BCD range
• When a device of the controller is specified as the write destination device of a while statement
For the available data type and data range, refer to the following.

➟9.9.2 ■4 Available data and how to express the data
For the details of the while statement, refer to the following.

➟9.9.2 ■3 Control structures for a project script, screen script, and script part
For troubleshooting the script processing stop, refer to the following.

➟9.9.14 Troubleshooting

(3) Variation of the result of processing depending on data types
In the following cases, you may get an unexpected result of processing.
• When a data type other than [BCD16], [BCD32], or [BCD64] is selected as the script data type but a constant out of the 
selected type range is included

• When [Unsigned BIN16] or [Unsigned BIN32] is selected as the script data type but a negative constant is included
• When a data type other than [Real] is selected as the script data type but a value with the decimal point is used as a 
constant

For the details of data types, refer to the following.
➟9.9.2 ■4 Available data and how to express the data

(4) Bitwise operation and data type
If you perform a bitwise operation on the device with a signed data type, an unexpected value may result.
Set an unsigned data type for the target device of a bitwise operation.

(5) Digit limitation when describing monitor devices
Depending on controllers to be monitored, the device number for them must be described in specific digits.
Otherwise, malfunction may result.
For the details of how to describe the device number, refer to the following.

➟9.9.2 ■4 Available data and how to express the data

(6) Writing the project in the GOT after editing the script
If you edit a screen script or an object script, write the project being edited in the GOT.
Otherwise, the change you made is not reflected to the GOT.

(7) Operation while a script is being edited
When you click the [Edit Script] button and edit a script using a script editor or a text editor, you cannot operate GT 
Designer3.
GT Designer3 reacts as if it freezes up then, but once you close the script editor or the text editor, you can operate GT 
Designer3 again.
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(8) Precautions for assignment delay
(a) Assignment delay

Depending on devices where you write the operation result of scripts, some time (called assignment delay) is needed for 
writing the result to the device when the operation of a script is complete.
The following shows whether each device needs assignment delay or not.

Synchronized: The result is written in synchronization with the script. Delay: Assignment delay occurs.

If you perform an assignment as shown in example 1, an assignment delay leads to an unexpected operation result.
To reduce the frequency of communication with the PLC CPU to lower the influence on the monitoring process, describe 
the script as shown in example 2 or 3.
Example 1) Assignment using PLC CPU devices

In this example, due to an assignment delay, after the script ends, the operation result of the first line (D0+1) is reflected to 
D1.
Therefore, the operation result of the first line is not reflected to that of the second line (D1*2).
Example 2) Assignment using a temporary device area

Using a temporary device area for the script avoids an assignment delay.
For the details of temporary device areas, refer to the following.

➟9.9.2 ■4 Available data and how to express the data
Example 3) Assignment processing using GOT internal devices (GD, GB)

Device and temporary 
device area Script

Controller device Delay

GB

Synchronized
GD

GS

TMP

D0 100 100

200 101

300 400

D1

D2

[w:D1] = [w:D0]+1; // Assign the operation result of D0+1 to D1.
[w:D2] = [w:D1]*2; // Assign the operation result of D1*2 to D2.

[w:D0] + 1

[w:D1] * 2

Script starts. Script ends.

[w:TMP0001] = [w:D0]+1; // Assign the operation result of D0+1 to TMP0001.
[w:D1] = [w:TMP0001]; // Assign the value of TMP0001 to D1.
[w:D2] = [w:TMP0001]*2; // Assign the operation result of TMP0001*2 to D2.

D0 100 100

200 101

300 202

D1

D2

[w:TMP0001]=[w:D0] + 1

[w:D1]=[w:TMP0001]

[w:D2]=[w:TMP0001] * 2

Script starts. Script ends.

[w:GD1] = [w:D0]+1; // Assign the operation result of D0+1 to GD1.
[w:D1] = [w:GD1]; // Assign GD1 to D1.
[w:D2] = [w:GD1]*2; // Assign the operation result of GD1*2 to D2.
9 - 416 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

The processing timing with GOT internal devices (GD and GB) is the same as one with temporary device areas. Therefore, 
you can avoid assignment delays.

(1) LS devices specified in a script created using SCHNEIDER EJH software
The LS devices specified in the script language of SCHNEIDER EJH software are designed to be free 
from assignment delays.
Therefore, when a script including LS devices shown in example 1 above is converted, the converted 
script may not run as intended on the GOT.
To prevent an assignment delay, use temporary device areas for scripts including LS devices as shown 
in example 2 above.

(b) Assignment delay when an offset is specified
• When reading values from devices

If you specify an offset in a script when devices of controllers are used as base devices, assignment delays may 
occur and the script may not operate correctly even if the values of offset devices are changed.
Example 1) Specifying a target device for reading with an offset device does not work correctly (when R200 = 10)

In the above example, the value of the offset device (TMP0000) remains the same as that before the assignment.
If the device numbers are out of the range of the base device (R), an error occurs.
If no assignment delays occur, use the temporary device area or GOT internal devices for both base devices and 
offset devices.
Example 2) Measure to avoid the assignment delay using temporary device areas (when R200 = 10)

By assigning the values of R devices to the temporary device areas using bmov in advance, the operation that cannot 
be done in example 1 becomes available.
Notes on example 2
In example 2, the range of the offset device (R200) is 0 to 10, and the values of 11 devices counted from the base 
device (R100) are assigned to the temporary device areas.
Therefore, the number of devices to be assigned to the temporary device areas must be changed according to the 
range of offset devices.

• When writing values to devices
When writing values to devices, there are no specific restrictions applied when reading values from devices. (Refer 
to the following example 1.) However, when controller devices are used as base devices, you cannot assign values 
repeatedly by switching values of offset devices in a while statement as shown in example 2.
Even in this case, it becomes available by using the temporary device area or GOT internal devices (GB and GD) for 
both base devices and offset devices in the same way as mentioned earlier for reading values from devices.
Example 1) Specifying a target device for writing with an offset device (Enabled)

Example 2) Specifying a target device for writing with an offset device in a while statement (Disabled)

Example 3) Measure to avoid the error in example 2

[w:TMP0000]=[w:R200]; 
[w:TMP0001]=[w:R100[w:TMP0000]];    The value of R110 cannot be referred at this timing. 
     Base device                  Offset device

bmov([w:R100],[w:TMP0100],11) 
[w:TMP0000]=[w:R200]; 
[w:TMP0001]=[w:TMP0100[w:TMP0000]];    The value of R110 can be referred at this timing.

                 [w:TMP0000]=10; 
                 [w:R100[w:TMP0000]]=[w:TMP0001];    The value can be assigned to R110 at this timing. 
Base device                     Offset device

[w:TMP0000]=10; 
while([w:TMP0000]<20){ 
[w:R100[w:TMP0000]]=[w:TMP0001];           An error occurs. 
[w:TMP0000]=[w:TMP0000]+2;
}
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By assigning the values last assigned in the temporary device areas with R devices using bmov, the operation that 
cannot be done in example 2 becomes available.

(9) Simulating using a general C language compiler or debugger
• If [BCD32], [BCD16], or [BCD64] is selected as the script data type, you cannot perform a simulation using the general 
C language compiler or debugger.

• Since the set, rst, alt, bmov, and fmov statements are dedicated for scripts, you cannot perform a simulation using a 
general C language compiler or debugger.
Use assignment of 1 or 0 instead of the set or rst statement.

• When you use the system define (ON, OFF description) of the GOT as they are, the define for it must be added to the 
C language source file.

• The assignment delay which occurs when a script is executed on the GOT does not occur during a simulation using a 
general C language compiler or debugger.
Therefore, when performing a simulation, take a possibility of occurrence of assignment delays into consideration.

• By applying the measures above, a new program created using C language then debugged can be used as a GOT 
script.

• Offset device specification cannot be made in the above debugging process.
If you debug the offset specified device, it is necessary to set the corresponding device in advance.

(10)Character code applicable to a file name
(a) Character code applicable to the utility

Only ASCII code is applicable to the screens for file manipulations in the utility.
A file name, which is not encoded in ASCII, is displayed incorrectly in the utility.

(b) Character code applicable to the file transfer (FTP client) function
When a transfer file name is indirectly specified in the file transfer (FTP client) function, only ASCII code is applicable to the 
file name.
The file transfer (FTP client) function cannot transfer a file whose name is not encoded in ASCII.

(11)Script error control and GOT status
While the GOT displays a screen in which no script is set, the following operations are not available.
• Clearing script error data or executing a script stopped due to an error by using the Script Common Control (GS384)

➟12.1.3 ■5 (1) Script Common Control (GS384)
• Resetting script error data in the [GOT Diagnostics] dialog

➟11.14.5 [GOT Diagnostics] dialog
Perform the above operations while the GOT displays a screen in which a script is set.

bmov([w:R110],[ｗ：TMP0110],10); 
[w:TMP0000]=10; 
while([w:TMP0000]<20){ 
[w:TMP0100[w:TMP0000]]=[w:TMP0001];         No error occurs. 
[w:TMP0000]=[w:TMP0000]+2;
} 
bmov([ｗ：TMP0110],[w:R110],10);
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(12)Precautions for setting [Sampling], [ON Sampling], or [OFF Sampling] for the trigger type
(a) If a script does not complete within the set cycle time

If a script does not complete within the set cycle time, its subsequent execution is delayed until the current execution 
completes.
After the set cycle time elapses from the start of the delayed execution, the script starts its new execution.
Example) Executing a project script for which [Trigger Type] is set to [Sampling] and [Sampling] is set to [1] (x 100 ms)

(b) If the trigger condition for a script is satisfied while any processing other than the script is in progress
If the trigger condition for a script is satisfied while any processing other than the script (including reading or writing a file 
and updating a screen) is in progress, the script execution is delayed until the processing completes.
After the set cycle time elapses from the start of the delayed execution, the script starts its new execution.
Example) Executing a project script for which [Trigger Type] is set to [Sampling] and [Sampling] is set to [1] (x 100 ms)

(c) If the scripts running periodically are set for multiple screens to be displayed simultaneously
When these screens are displayed simultaneously, the scripts may fail to run at short time intervals, such as every 100 ms.
In such a case, set a longer cycle time.

Project script

Elapsed time (ms)
100 ms

100 ms 100 ms

Being 
processed

Not 
processed

200 ms 300 ms 400 ms 500 ms

After 100 ms elapses from the start of the previous execution, 
the script starts its new execution.

The script starts its new execution upon 
completion of the previous execution.

100 ms

Any other processing 
(including reading 
or writing a file)

Project script

Elapsed time (ms)
100 ms

100 ms 100 ms100 ms

Being 
processed

Not 
processed

Being 
processed

Not 
processed

200 ms 300 ms 400 ms 500 ms

After 100 ms elapses from the start of the previous execution, 
the script starts its new execution.

The script starts its new execution 
upon completion of the other processing.
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(13)Precautions when using the string operation function and file operation function
The [File/Text Handling Function Storage Order] setting for the string operation function and file operation function may 
not be applied depending on arguments.
When the setting is not applied, the argument storage order is fixed to [Low-->High].

➟9.9.5 ■4 [Option] tab

When selecting [High-->Low] for [File/Text Handling Function Storage Order] and using a string operation function and a 
file operation function together, the resulting operation may not be as intended depending on whether the setting for [File/
Text Handling Function Storage Order] is applied or not.

■2 Precautions for drawing
(1) Restoring a script file

When opening a project for which [External File (External Data)] is set in the [Option] tab, GT Designer3 restores the 
script file if the script file does not exist in the set path.
In such a case, specify a folder in which the script file should be restored in the dialog shown below.

(2) When [Use system labels in conjunction with MELSOFT Navigator] is disabled
When [Use system labels in conjunction with MELSOFT Navigator] is disabled, system labels used in scripts are not 
converted to devices.
Set the devices for project data.

■3 Precautions when writing a script
(1) Operations that exceed the allowable range of a device value

Do not write a script that causes an operation result which exceeds the allowable range of a device value.
Script operation is processed internally in double-precision real numbers.
Therefore, when a judgment is made using an if statement and others, the result of the judgment may differ depending 
on the operation methods.
Example) Judgment for the difference between GD100 and D100 using an if statement (in the case of 16-bit signed 
binary)
When GD100 = -32758 and D100 = 32767

(a) When operation is executed in an evaluation expression
if(([w:GD100]-[w:D100])>=10){ //If the difference between GD100 and D100 is 10 or larger,
[w:D200]=0; //Writes 0 to D200.
}
The calculation result of "GD100 - D100" (-32758 - 32767) is -65525, thus the condition is not satisfied.

(b) When processing the script after assignment
[w:GD200]=[w:GD100]-[w:D100]; //Assigns the value of "GD100 - D100" to GD200.

Function Argument used to apply the [File/Text Handling Function 
Storage Order] setting

Argument not used to apply the [File/Text Handling 
Function Storage Order] setting

String operation function
• Input string storage device
• Output string storage device

• Arguments other than the input string storage device and 
output string storage device

File operation function
• File read function storage device
• File write function storage device
• File line read function storage device

• Arguments other than the storage device for the file read 
function

• Arguments other than the storage device for the file write 
function

• Arguments other than the storage device for the file line 
read function

• All arguments available for the file list obtaining function
• All arguments available for the folder list obtaining function
• All arguments available for the file renaming function
• All arguments available for the file deletion function
• All arguments available for the file copy function
• All arguments available for the folder copy function
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if([w:GD200]>=10){ //When the value of GD200 is 10 or larger,
[w:D200]=0; //Writes 0 to D200.
}
When -65525; the calculation result of "GD100 - D100" (-32758 - 32767), is assigned to GD200 in 16-bit signed binary, 
GD200 becomes 10, so the condition is satisfied.
(Since a value out of the range that can be handled by a variable (device) is assigned as the result of an operation, the 
result differs from the result obtained in (a).)

(2) Data type settings and function definitions
Use an argument by casting the set device data type to the data type defined by the function.
Include the return value by casting the operation result obtained in the data type defined by the function to the set device 
data type.
To use the argument or return value in the data type defined by the function, set the following data type.

• long: Signed BIN32
• double: Real number (64 bits)

(3) When using bmov and fmov
(a) Data type

When using bmov or fmov, use the same data type for the word device 1 and the word device 2.
Otherwise, an error occurs during the syntax check.

➟9.9.5 [Script] dialog

(b) Data type for [w:device]
The data type for [w:device] is set to the one specified in the [Edit Script] dialog.
The following example shows an error that occurs in the syntax check when using [w:device].
Example) When setting [Signed BIN16] for the data type in the [Edit Script] dialog
bmov([w:GD200],[flt:GD201],10);
Since the data type for GD200 is the signed 16-bit binary data while the data type for GD201 is the real number, an error 
occurs in the syntax check.

➟9.9.2 ■4 (17) Data type conversion function

(c) Syntax check
When a syntax check is done from the [Script File List] dialog, the data type is regarded as [Signed BIN16].
When executing a syntax check using a data type other than [Signed BIN16], first set a desired data type in the [Edit Script] 
dialog, then execute the syntax check from the script editor.

(4) When using file operation functions
GT21 and GS21 do not support the file operation functions.

(a) Data type
When using the file operation functions, do not specify BCD for the data type of the storage devices.
Doing so may disable detection of abnormality in the script.

➟9.9.5 [Script] dialog

(b) Data type for [w:device]
The data type for [w:device] is set to the one specified in the [Edit Script] dialog.
When using [w:device] for the file operation functions, do not specify BCD for the data type of the storage devices.

(c) Syntax check
When a syntax check is done from the [Script File List] dialog, the data type is regarded as [Signed BIN16].
When executing a syntax check using a data type other than [Signed BIN16], first set a desired data type in the [Edit Script] 
dialog, then execute the syntax check from the script editor.

(d) Operations while files are read or written
The following file operation functions cannot be executed while the target file is accessed by other functions.
Execute the functions after the access to the target file from the other functions is complete.

• While reading: file_read, file_write, file_lineread, file_unilineread, file_delete
• While writing: file_read, file_write, file_lineread, file_unilineread, file_rename, file_delete

(e) When using the file rename function (file_rename)
When the full path to a file to be renamed is specified in <folder name>, do not leave <file name> blank.
Otherwise, the file name is not renamed correctly.
Example) When specifying the full path to a file in <folder name> without setting <file name>
[s16:D500] = file_rename("A:\\Package1\\ARP00001.DAT", "", "DATA-15-JAN-08.DAT"); //Renames file name.
The file name with the folder name is renamed from "A:\Package1\ARP00001.DAT" to 
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"A:\Package1\ARP00001.DATDATA-15-JAN-08.DAT".
When specifying the full path to a file in <file name>, specify the full path to the file in <renamed file name> also.
Otherwise, the path is changed together with the change of the file name.
Therefore, the file is not moved in the intended location.
Example) When specifying the full path to a file in <file name> without setting <folder name>
[s16:D500] = file_rename("", "A:\\Package1\\ARP00001.DAT", "DATA-15-JAN-08.DAT"); //Renames file name.
The file name is renamed from "A:\Package1\ARP00001.DAT" to "A:\DATA-15-JAN-008.DAT".

(f) When using the file copy function (file_copy)
If there is no folder specified in <copy destination folder name>, create a folder when copying the file.
Make sure to add "\\" at the end of <copy destination folder name>.
Otherwise, the file is renamed to the folder name specified in <copy destination folder name> and copied.
Example) When there is no folder specified in <copy destination folder name> and "\\" is not added at the end of <copy 
destination folder name>
[s16:D200] = file_copy("A:\\Package1\\ARP00001.DAT", "B:\\backup", "", 1); //Copies file.
If no backup folder exists in the drive B, "ARP00001.DAT" is renamed to backup and copied in "B:\\".
Do not create any folder in the same name as that of the file specified in <copy source file name> in the copy destination 
drive.
Otherwise, the file cannot be copied correctly.

(g) When using the folder copy function (file_xcopy)
If an error occurs during the copying process, copying files stops.
The files copied before interruption are correctly copied.
Do not create any folder in the same name as that of the file specified in <copy source file name> in the copy destination 
drive.
Otherwise, the file cannot be copied correctly.

(h) How to use the folder and file name character number specification functions (#pragma 
folder_name_length, #pragma file_name length) and the use Unicode declare function (#pragma 
use_character_code unicode)
Use the folder and file name character number specification function and the use Unicode declare function only one time 
at the start of a script.
Otherwise, the folder name and file name cannot be specified correctly.

(i) When specifying the folder and file names using devices
When specifying the folder and file names using devices, keep the values that are specified by the folder and file name 
character number specification functions (#pragma folder_name_length, #pragma file_name length) to a minimum.
When specifying the folder and file names with devices, the GOT reads as many devices as the number of the characters 
specified in the folder and file name character number specification functions.
If the values specified in the functions exceed the actual number of the file and folder name characters, the GOT reads 
unnecessary devices.
Reading unnecessary data results in an excessive load on the communication process, so such an operation as updating 
a screen or executing a script may take longer time.
Example) When the maximum number of file name characters is set to 22 and the number of actual file name characters 
is 16
D100 to D110: Holds the folder name "A:\folder-00001\".
D200 to D210: Holds the file name "DATA-15-JAN-2008".
GD100: Storage device

D100 A:
D101 \f
D102 ol
D103 de
D104 r-
D105 00
D106 00
D107 1\
D108
D109
D110

D200 DA
D201 TA
D202 -1
D203 5-
D204 JA
D205 N-
D206 20
D207 08
D208
D209
D210

Unnecessary 12 characters
of devices are read.

#pragma folder_name_length(22)                                         //Limits the maximum folder name length to 22 characters. 
#pragma file_name_length(22)                                             //Limits the maximum folder name length to 22 characters. 
[s16:D500]=file_read([w:D100],[w:D200],[w:GD100],0,16);  //Reads the 16-byte data from the specified file.
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(5) When using the string operation function
GT21 and GS21 do not support the string operation functions.

(a) Available character strings
The string operation function handles ASCII and Shift JIS strings.
If a target string contains any character other than ASCII and Shift JIS characters, a script error occurs.

(b) Return value when an error occurs
If an error occurs when data in a device set as an argument is being read or written, execution of the script is aborted.
Therefore, no return value is stored in the device for storing the return value.

(c) Order of storing data
The order of storing data in the following processes is selectable from between [Low-->High] and [High-->Low].

• Reading data to the input value storage device
• Writing data to the output string storage device

➟9.9.5 ■4 [Option] tab

(6) Precautions for format specification
(a) Field width of the format specifier

When the string input function (ASCII code) is used, the values skipped due to their skip flags (*) are not counted as the 
number of read data (return value).

(b) Count of the skipped data
When the string input function (ASCII code) is used, the values skipped due to their skip flags (*) are not counted as the 
number of read data (return value).

(c) Characters that cannot be specified with the format specifier "%[...]"
With the format specifier "%[...]", the following symbols cannot be specified.
Doing so may result in a format error.
-,]

(d) Specifying a format with comments
Comments consist of the Unicode text.
When specifying the format with a comment, do not use a character that cannot be converted from the Unicode text to the 
ASCII characters.
If such characters are used, they are replaced with blanks.

(e) Data delimiter of a CSV file
When reading data obtained from a CSV file, or writing data in character strings to be written to the CSV file, indicate a 
delimiter with the format specifier.
Example) When reading obtained numerical values from a CSV file

• If delimited by a blank: 123 456 can be read with the syntax %d%d.
• If delimited by a comma: 123,456 can be read with the syntax %d,%d can read.

(f) Character string delimiters
When a character string is read using "%s", a comma is not recognized as a delimiter but as a part of the string.
Therefore, the string with a comma for a delimiter is read as one data including the comma.
To read the character string as the data that is delimited by a comma, use "%[^,]" to read characters other than the comma, 
and then skip the delimiter with the comma.
Example) When reading the character string ABC,DEF with "%s"
GD100 to D108: Holds the character string ABC,DEF.
GD200: Input value storage device 1
GD250: Input value storage device 2
[s16:GD500]=str_scanf([w:GD100],7,0,"%[^,],%s",GD200,GD250); //Reads the 7-byte character string.

D100 to D104: Source character string

Reads charactersother than a comma
and endsreading when a comma 
is found.

Reads the remaining character string.

%[^,]

%s

Skips the comma.,

A B C , D E F

D200
 and the following 

devices
ABC

D250
 and the following 

devices
DEF
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Blanks are recognized as delimiters. Therefore, if a character string including blanks is read, it is read as multiple data.
To read a character string with blanks as one data, use "%[^,]" to read characters other than a comma, then skip a delimiter 
with the comma.
Example) When reading the character string ABC D,EFG by using the above script

(g) Number of significant digits for the single precision real number
The maximum number of significant digits for the single precision real number is six.
If the precision with six digits or more is set for the format specifier, the result may be incorrect.

(h) Differences in the written result between the GOT and GT SoftGOT2000 or GT Simulator3
Some of the processing differs between the GOT and GT SoftGOT2000 or GT Simulator3.
If real numbers with the precision of more than six are written, the results may differ between the GOT and GT 
SoftGOT2000/GT Simulator3.

(i) When writing a character string with "%s"
Starting from the device to be written, a number of devices corresponding to that of characters are used.
Reserve the writable device area in advance.

■4 Precautions when setting a project script
The monitor device of a project script is always operating.
Note that displaying the monitor screen may take long when the number of monitor devices is large.

■5 Precautions when switching the screen
If screen switching is executed while a screen script or the script of a script parts object is running, the target screen will not 
be switched until the script ends.
If screen switching is executed while a project script is running, the script will temporarily stop running until the target screen 
is switched.

■6 Precautions for script parts
(1) Behavior of a script parts object on the screen displayed in multiple locations

If an overlap window, superimpose window, and the set overlay screen function call a screen having a script parts object, 
the script of the script parts object runs only when the screen is called up for the first time.
The script does not run in the other locations even after you close the screen where the script has run.
In the above state, if the screen is called up again in any of these locations, the script will run on the newly displayed 
screen.

(2) User area to be used when script parts temporary device areas (PTMP) are used
When you use PTMPs, the size of the user area to be used depends on the number of the PTMPs.
Set a minimum number of PTMPs.

(3) Syntax check on PTMPs
In a syntax check, whether the number of PTMPs falls within the following range is checked regardless of the settings of 
the GOT type and #pragma use_ptmp_length.
• 32768 (PTMP0 to PTMP32767)
Even if the number of PTMPs is invalid according to the above settings, no error will occur during the syntax check.
You must check that the number of PTMPs is within the valid range.

D100 to D104: Source character string

Reads characters other than a comma
and ends reading when a comma 
is found.

Reads the remaining character string.

%[^,]

%s

Skips the comma.,

A B C D , E F

ABC  D

EF

D200
 and the following 

devices

D250
 and the following 

devices
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■7 Precautions when using bmov
For project scripts or screen scripts, using many bmov commands to read device values from the controller and to store 
them in the GOT internal devices may slow the performance of the GOT display refresh or the reaction of the touch switch 
input.
This section explains how to make the GOT monitor operate at a higher speed by reducing the frequency of the 
communication with controllers by bmov.

(1) How to read device values from controllers without bmov
The GOT can read device values with device data transfer instead of bmov.
With device data transfer, the GOT communicates with controllers only when trigger conditions are satisfied. Therefore, 
the GOT has no communication loads by always monitoring the device used for the script function.
For the details of device data transfer, refer to the following.

➟9.4 Transferring Data between Devices ([Device Data Transfer])

(2) How to reduce the communication time when using bmov
If the following read operations are performed by the screen script, the script applies only to the currently displayed screen 
on the GOT.
With project scripts or screen scripts, the GOT only reads a batch of device values from the controller direct addresses 
all the time, regardless of execution condition of each script, or conditional branches using if or switch statements.
When the offset is specified in the device, the offset device is the device described in the direct address.
Also, when using bmov to read device values from controllers, the GOT only reads the values of source devices all the 
time by communicating with the controllers one or more times by bmov.
To reduce the communication time, it is recommended that you read a batch of values from the source devices 
temporarily into a temporary device area.
Perform the following remedies.

(a) If device values are read from controllers in divided blocks, change the script into the one that reads 
a batch of values temporarily into the temporary device area, then divides them again, and then 
transfers them to the GOT internal devices.

➟(3) Script solution examples

(b) If the GOT reads device values according to each execution condition of an if or switch statement, 
read the values temporarily into the temporary device area before the if or switch statement is 
executed.
Then, change the script into the one that transfers the values from the temporary device area to the GOT internal devices 
by dividing the values into groups according to the condition of if or switch statement.

➟9.9.12 ■7 (3) (b) Reading bmov commands in a script at a time
When reading a batch of devices from the controller to the temporary device area, refer to the number of words (size) shown 
in the table below as a guide.
If the number of words is larger than the guide, the number is automatically divided in controllers before they are transferred.

Controller type Approximate number of words transferred by bmov at a time

QCPU (bus connection only)
960 words

Motion CPU (Q mode)

QCPU (other than bus connection)

480 words
LCPU

QnACPU

Motion CPU (A mode)

ACPU
64 words

FXCPU
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(3) Script solution examples
(a) Reading a batch of device values into a temporary device area

This solution saves the communication time by reducing the frequency of communication between the GOT internal 
memory and the controller from three times to once.
When data are transferred from a temporary device area to GOT internal devices (such as GD), the internal memory does 
not communicate with controllers.
The internal memory is used for communication processing.
It is a system area, and the user is not permitted to access to the area.
Before applying remedy

• Processing outline
Device values are transferred from R1000 to R1004, R1010 to R1014 and R1020 to R1024 into GD360 to GD364, 
GD370 to GD374 and GD380 to GD384 respectively.

• Script description

After the remedy is applied
• Processing outline

Device values are transferred from R1000 to R1024 into TMP0 to TMP24 in the GOT first, then transferred again 
from TMP0 to TMP24 into GD360 to GD364, GD370 to GD374 and GD380 to GD384 respectively.

• Script description

(b) Reading bmov commands in a script at a time
This solution saves the communication time by reducing the frequency of communication between the GOT internal 
memory and the controller from ten times to once.
(When internal devices in a controller are read in an if or switch statement, the internal memory communicates with the 
controller regardless of the operating condition. When data are transferred from a temporary device area to GOT internal 
devices (such as GD), the internal memory does not communicate with controllers.)
Before applying remedy

• Processing outline
Device values are transferred from R1000 to R1004, ··· and R1900 to R1904 into GD360 to GD364 according to the 
case statements.

• Script description

GD
Internal 
memory

R1000 to R1004

R1010 to R1014

GD360 to GD364

GD370 to GD374

GD380 to GD384

Internal devices 
in a controller

GOT

3 times : Indicates communication with the controller.
: Indicates the processing by bmov.

R1020 to R1024

bmov([w:R1000],[w:GD360],5);
bmov([w:R1010],[w:GD370],5);
bmov([w:R1020],[w:GD380],5);

GD
Internal
 memory

Internal devices
 in a controller

GOT

: Indicates communication with the controller.
: Indicates the processing by bmov.

GD380 to GD384

GD360 to GD364

GD370 to GD374

Once

R1000 to R1024

TMP0 to TMP4
TMP5 to TMP9

TMP10 to TMP14

TMP20 to TMP24
TMP15 to TMP19

bmov([w:R1000],[w:TMP0],25);
bmov([w:TMP0],[w:GD360],5);
bmov([w:TMP10],[w:GD370],5);
bmov([w:TMP20],[w:GD380],5);
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After the remedy is applied
• Processing outline

Device values are transferred from R1000 to R1904 into TMP0 to TMP904 in the GOT at a time, then transferred 
again from TMP0 to TMP904 into GD360 to GD364 according to the case statements.

• Script description

switch([w:D1000]){
case 1:
bmov([w:R1000],[w:GD360],5);
break;
case 2:
bmov([w:R1100],[w:GD360],5);
break;
:
case 9:
bmov([w:R1800],[w:GD360],5);
break;
case 10:
bmov([w:R1900],[w:GD360],5);
break;
}
rst([b:GB1000]);

case
1

2
:
:
9

10

Internal devices
 in a controller GD

GD360 to GD364

GOT

10 times

R1000 to R1004

R1100 to R1104
:
:

R1800 to R1804

R1900 to R1904

Internal
 memory

:
:

: Indicates communication with the controller.
: Indicates the processing by bmov.

bmov([w:R1000],[w:TMP0],905);
switch([w:D1000]){
case 1:
bmov([w:TMP0],[w:GD360],5);
break;
case 2:
bmov([w:TMP100],[w:GD360],5);
break;
:
case 9:
bmov([w:TMP800],[w:GD360],5);
break;
case 10:
bmov([w:TMP900],[w:GD360],5);
break;
}
rst([b:GB1000]);

Internal devices
 in a controller GD

GD360 to 
GD364

GOT

Once

R1000 to 
R1904

Internal
 memory case

1

2
:
:
9

10

TMP0 to TMP4
TMP5 to TMP99
TMP100 to R104

:
:

TMP800 to TMP804
TMP805 to TMP899
TMP900 to TMP904

: Indicates communication with the controller.
: Indicates the processing by bmov.
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9.9.13 Relevant settings

Set the relevant settings other than the specific settings for project scripts, screen scripts, and script parts as required.
The following shows the functions that are available by the relevant settings.

■1 GOT internal device
➟12.1.3 GOT special register (GS)

○ : Applicable, -: Not applicable

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item Project script Screen script Script part

Notifying that a script error has occurred. GS14.b0 ○ ○ ○

Notifying that a BCD error has occurred. GS14.b7 ○ ○ ○

Notifying that a zero division error has occurred. GS14.b8 ○ ○ ○

Notifying that a communication error (including access to an invalid 
device) has occurred. GS14.b12 ○ ○ ○

Storing the start device number of the devices where the latest error 
record is stored. The devices range from GS16 to GS47. GS15 ○ ○ -

Storing the script error records (including script numbers and error 
codes). GS16 to GS47 ○ ○ -

Storing the device number of the device where the latest script 
execution record is stored. The device is in the range of GS49 to 
GS79.

GS48 ○ ○ -

Storing the script numbers of the executed scripts. GS49 to GS79 ○ ○ -

Notifying that a file operation function is being executed. GS154.b0 ○ ○ ○

Notifying that a file operation function error has occurred. GS154.b15 ○ ○ ○

Storing a number showing the GOT data registers (GD) where the 
latest error record is stored. The GD devices are specified with GS392 
and GS394.

GS157 ○ ○ ○

Storing a number showing the GOT data registers (GD) where the 
latest script execution record is stored. The GD devices are specified 
with GS396 and GS398.

GS158 ○ ○ ○

Notifying occurrence of an error which occurs while the integer ← → 
real number conversion is processed. *1

GS260.b14 ○ ○ ○

Notifying the completion of the integer ← → real number conversion. *1 GS260.b15 ○ ○ ○

Storing the error code of an error which occurs while the integer ← → 
real number conversion is processed. *1

GS261 ○ ○ ○

Clearing script error records as shown below.
• GS14.b0, b7, b8, and b12 store 0.
• GS15 stores -1.
• GS16 to GS47 store 0.

GS384.b0 ○ ○ ○

Re-executing the script aborted due to an error. GS384.b1 ○ ○ ○

Setting the monitoring time for one script. GS385 ○ ○ ○

Controlling whether to run a script upon screen switching or other 
applicable processes. The applicable script trigger types are as 
follows.
• [Rise]
• [Fall]
• [Rise/Fall]

GS386 ○ ○ ○

Specifying a data storage order when a file operation function is used. 
*1 GS390 ○ ○ ○

Storing the detailed script error records.
GS392
GS394
GS395

○ ○ ○

Storing the detailed script execution records.
GS396
GS398
GS399

○ ○ ○
9 - 428 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

*1 Not available to GT21 and GS21.

9.9.14 Troubleshooting

Scripts do not display error messages when an error occurs. Stopping the script where an error has occurred prevents other 
scripts and monitor functions from stopping. Therefore, every script must be debugged following the procedures as shown 
below.

■1 Simulation using a general C language compiler or debugger
Since scripts and C language are similar, you can simulate the scripts by making minor corrections using a general C 
language compiler or debugger.
Complicated scripts including many control statements can be debugged easily by using them.
The following shows the procedure to simulate scripts using a general C language compiler or debugger.

Step 1 Change a script file for GOTs (extension.txt) into a C language source file (extension.c).
• Change of the file extension: text1.txt → text1.c

Step 2 Open the C language source file in a commercially-available text editor and create a frame with "main(){}".
Describe "#include<stdio.h>" at the beginning.
• Additional description of "main" and "include"

Step 3 Change the description method of devices (variables) from the one for scripts to the one for C language.
Using the following definitions to change the variables into the one for C language enables you to smoothly 
restore them into the GOT scripts.
Using the batch replacement function of a commercially-available text editor may be useful for the change as 
well.
Definition 1 [w: → _w
Definition 2 [b: → _b
Definition 3 ] → __
• Change of the description method of devices (variables)

Step 4 For C language, variables to be used must be defined in advance.
Since only one data type can be set for one script, the same variable type of C language must be set for all the 

Executing an integer-to-real number conversion.

GS460
GS461
GS462
GS463
GS464

○ ○ ○

Function Setting item Project script Screen script Script part

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

#include<stdio.h>
main(){
  [w:TMP0001]=0;
  while([w:TMP0000]<[w:D100]){
    if(!(([w:TMP0000]-1900)%4)){
       [w:TMP0001]=[w:TMP0001]+1; 
    ••• ( Omitted) ••• 
  [w:TMP0010]=[w:TMP0002]+[w:TMP0003]+[w:TMP0004]-1;
  [w:D200] = [w:TMP0010]%7;
}

Additional description→ 
Additional description→ 

Additional description→

#include<stdio.h>
main(){
  _wTMP0001__=0;
  while(_wTMP0000__<_wD100__){
        if(!((_wTMP0000__-1900)%4)){
        _wTMP0001__=_wTMP0001__+1; 
     ••• ( Omitted) ••• 
  _wTMP0010__=_wTMP0002__+_wTMP0003__+_wTMP0004__-1;
  _wD200__ = _wTMP0010__%7;
}

Description change→ 
Description change→ 
Description change→ 
Description change→ 

Description change→ 
Description change→
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variables.
The following shows the data type of scripts.
If [BCD32], [BCD16], or [BCD64] is selected as the script data type, you cannot perform a simulation using the 
general C language compiler or debugger.

• Variable definition (auto variable declaration)

Step 5 Perform a simulation with the general C language compiler or debugger.
The step run, variable watch, and other functions specific to the debugger can be used.
After completion of debugging, perform Step 1 to 4 in reverse order to restore the data into the GOT script file.

Data type of scripts Variable type

Signed BIN 16 short

Unsigned BIN 16 unsigned short

Signed BIN 32 long

Unsigned BIN 32 unsigned long

Signed BIN64 long long

Unsigned BIN64 unsigned long long

BCD16

-BCD32

BCD64

Real(32bit) float

Real(64bit) double

#include<stdio.h>
void main(void){
  unsigned short _wTMP0000__;
  unsigned short _wTMP0001__;
  unsigned short _wTMP0002__;
  unsigned short _wD100__; 
    ••• ( Omitted) ••• 
  _wTMP0001__=0;
  while(_wTMP0000__<_wD100__){
      if(!((_wTMP0000__-1900)%4)){
      _wTMP0001__=_wTMP0001__+1; 
    ••• ( Omitted) ••• 
  _wTMP0010__=_wTMP0002__+_wTMP0003__+_wTMP0004__-1;
_wD200__ = _wTMP0010__%7;
}

Description change→ 
Addition  → 
Addition  → 
Addition  → 
Addition  →
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■2 Messages to be displayed at the syntax check
(1) Dialog to be displayed at the syntax check

When you execute a syntax check, the [Script Check] dialog appears to display the error codes of the errors detected in 
a script.
For the details of the error codes, refer to the following.

➟(2) List of syntax error codes
Example) When executing a syntax check on a project script

Some errors cannot be detected by the syntax check.
If any error which cannot be detected by the syntax check exists in the script, the error is detected when the script is 
executed on the GOT.
For the errors for the execution of a script and the corrective action on the GOT, refer to the following.

➟■3 Script execution errors and their corrective actions on the GOT

(2) List of syntax error codes
The [Script Check] dialog displays the error codes listed below.

Error code

Error code *1 Description

0 The syntax error of script

1 The odd number address is set to the address

2 Extended file register (ER) setting error (inter-block settings)

3 Address is only a multiple of 16

4*2 Out of the range of device No. (displayed in HEX. Number)

5*2 Out of the range of device No. (displayed in DEC. Number)

6 Out of the range of device No. (displayed in OCT. Number address)

7 The setting is not executed with the multiple of 16 when specifying the bit device word

8 The setting is not within the range of 0 to 15 when specifying word device bit

9 The set device is out of the range or does not exist

11 Illegal address

14 Access to the device disabling word accessibility by using bit

15 Access to the device disabling bit accessibility by using bit

16 Octal device are set with odd number

17 The setting is not executed with the multiple of 16 when specifying the bit device word

20 The specified CPU does not exist

21 The specified Word type does not exist

22 A CPU not included with network settings has been specified

24 2 byte code cannot be used

25 No expression exist between {and}

26 There are a lot of expression or control structure

27 There are a lot of expression or control structure

28 case outside of switch

29 "Default" exist although there is no switch statement

30 There are multiple "default" settings in switch
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31 There are too many switch "case" statements

32 There are too many "switch break" statements

33 Too many nest of switch

34 System memory is insufficient

35 Parenthesis nest is deep

36 Syntax error

37 There is no ' ; (semicolon) '

38 There are invalid characters

39 File input is not specified

40 The specified input file does not exist

41 The nest of if/while is deep

45 The CPU incompatible with multi-CPU is specified as multi-CPU

46 The multi-specified station No. is incorrect

47 Network in GOT internal devices

48 Set network in GOT internal devices

101 No closed parenthesis

111 The bit device is specified for the device with indirect specification

112 Controller Type of channel n is not specified or does not exist *3

113 Channel number error

114 Common device cannot use channel

115 The read only variable is written

116 The write only variable is read

117 The read only property is written

118 The write only property is read

119 Unterminated string

120 There is EOF in string

121 The string is too long

122 Unicode translation error

123 Cannot use EG device/the label with EG device allocation in object script

124 Cannot use word type cast

125 There are invalid variables

126 There are invalid properties

127 There are invalid functions

128 There are invalid device type

129 Unterminated label

130 There is EOF in label

131 The label is too long

132 An unavailable label is set

133 The device of label is invalid

134 The device of label is not set

135 Label conversion error

136 Data types of the 1st argument and 2nd one are not equal in bmov/fmov

137 value out of range

138 can't use #pragma except in script head

139 #pragma folder_name_length redeclared

140 #pragma file_name_length redeclared

141 Bit device word cannot be used

Error code *1 Description
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*1 If the station number setting of the device is incorrect, the same error may be displayed twice.
*2 For devices in which decimal numbers and hexadecimal numbers are used for device numbers (including a coil (MB) of 

YASKAWA PLC CP-9200SH), error code 4 occurs if a number outside the address range is specified.
*3 The letter "n" indicates a channel number.

142 Word device bit cannot be used

143 The format is invalid

144 The number of format designators is out of the valid range

145 The argument count is wrong

147 #pragma use_ptmp_length redeclared

148 PTMP cannot be used except for script parts

201 The device code is unknown

202 The device No. is beyond the valid range

203 Device No. + Device Points are beyond the valid range

204 The network No./Station No./CPU No. are beyond the valid range

205 The device name is invalid

206 The device No. notation is invalid

207 The address No. is invalid (not in even number or multiples of 8/16)

208 The device type is invalid

209 The GOT series is unknown

301 The GOT type does not support global labels/tags

302 Global labels/tags cannot be used for the controller of channel *3

303 The global label/tag/label (GT Designer3) is too long

304 An invalid character is used for the global label/tag/label (GT Designer3)

305 Global label/tag/label (GT Designer3) syntax error

306 The global label/tag that is not array type is used for the continuous device setting

307 An unregistered OPC UA tag is set

Error code *1 Description
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■3 Script execution errors and their corrective actions on the GOT
The following shows how to check the errors and their error codes on the GOT.

To check device values, use the device monitor function or objects (including a numerical display and lamp).

(1) Checking for the occurrence of an error
The following script types are supported: project script, screen script, and script part.
The following GOT internal devices notify the occurrence of errors.

To reset each bit of GS14, turn on GS384.b0.

Item Description

Checking for the occurrence of an error

Check for the occurrence of the following errors.
• Script error
• BCD error
• Zero division error
• Communication error (including access to an invalid device)
• File operation function error
The following script types are supported: project script, screen script, and script part.

➟(1) Checking for the occurrence of an error

Checking an error record

Check the following information of an error.
• Script number
• Error code
The following script types are supported: project script and screen script.

➟(2) Checking an error record

Checking a detailed error record

Check the following information of an error.
• Error code
• Script type
• Screen number
• Script number or object ID number
• Execution order number
• Screen type
• Number of the displayed base screen
The following script types are supported: project script, screen script, and script part.

➟(3) Checking a detailed error record

Clearing error records

Turning on GS384.b0 clears the script error records as shown below.
• GS14.b0, b7, b8, and b12 store 0.
• GS15 stores -1.
• GS16 to GS47 store 0.
The following script types are supported: project script, screen script, and script part.

Re-executing the script aborted due to an 
error

Turn on GS384.b1 to re-execute the script aborted due to an error.
The following script types are supported: project script, screen script, and script part.

GOT internal device Description

GS14

b0 Turns on when a script error occurs.

b7 Turns on when a BCD error occurs.

b8 Turns on when a zero division error occurs.

b12 Turns on when a communication error (including access to an invalid device) occurs.

GS154 b15
Turns on when a file operation function error occurs.
Turns off when the subsequent file operation function is properly completed.
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(2) Checking an error record
The following script types are supported: project script and screen script.
When an error occurs, the error record is stored into the devices ranging from GS16 to GS47.
GS15 stores the start device number of the devices where the latest error record is stored.
To clear error records, turn on GS384.b0.
The following shows the operation of the relevant GOT internal devices.

(3) Checking a detailed error record
The following script types are supported: project script, screen script, and script part.
The specified GOT data registers (GD) store error records.
These GD devices are specified with the following GOT special registers (GS).

• GS392: Specify the start device number of the GD devices to store error records.
• GS394: Specify the maximum number of error records.

Example) When GS392 stores 1000, and GS394 stores 5

Eight word devices are used for one error.
For the details of an error record, refer to the following.

➟(4) Details of an error record
To start storing error records, turn on GS395.b0.
You can identify the devices storing the latest error record based on the values of GS392 and GS157.
The following shows the operation of the relevant GOT internal devices.

• Write device

GOT internal device Description

GS15

Stores the start device number of the devices where the latest error record is stored. The devices range 
from GS16 to GS47.
The value of GS15 changes as follows each time an error occurs.
-1 → 16 → 18 → 20 → 22 → ... → 46 (The next loop will start from 16.)
Example) Relationship between the value of GS15 and the storage location of the latest error record
• When GS15 stores 16, the latest error record is stored in GS16 and GS17.
• When GS15 stores 46, the latest error record is stored in GS46 and GS47.
Turning on GS384.b0 resets GS15 to -1.

GS82 to GS113

Stores the following information when a script error occurs.
• Script number
• Error code
Two word devices are used for one error.

If the number of errors is 17 or more, the error records are overwritten starting from the oldest one.

GS16 Script number

GS17 Error code

GS18 Script number

GS19 Error code

GS46 Script number

GS47 Error code

1st error record

2nd error record

15th error record

GOT internal device Description

GS157

Stores a number showing the devices where the latest error record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest error record by using the 
following expression.
• GS392 + (GS157 × 8)
Example) When GS392 stores 1000, and GS157 stores 5
1000 + (5 × 8) = 1040
In this case, GD1040 to GD1047 (eight GD devices) store the latest error record.

GD1000 to GD1007
GD1008 to GD1015
GD1016 to GD1023
GD1024 to GD1031
GD1032 to GD1039

1st error record
2nd error record
3rd error record
4th error record
5th error record
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• Read device

(4) Details of an error record
The following shows an example of how an error record is stored in eight word devices starting from GD1000.

GOT internal device Description

GS392
Specify the start device number of the GD devices to store error records.
Data type: Unsigned binary

GS394

Specify the maximum number of error records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no error record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS395.b1 specifies the operation to be performed when the number of errors has 
exceeded the maximum number of error records.

GS395

b0
When this bit is turned on, storing error records starts.
When this bit is turned off, storing error records ends.

b1

Specifies the operation to be performed when the number of errors has exceeded the 
maximum number of error records specified with GS394.
When this bit is turned on, storing error records stops.
When this bit is turned off, storing error records continues by overwriting the oldest record.

b8 When this bit is turned on, the project script error records are not stored.

b9 When this bit is turned on, the screen script error records are not stored.

b10 When this bit is turned on, the script error records of script parts objects are not stored.

b11 When this bit is turned on, the records of warnings (that do not abort a script) are not 
stored.

Storage device Item Description

GD1000 Error code
Error code of an error.
For the error details and corrective actions, refer to the following.

➟(5) List of script execution error codes

GD1001 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 1: Project script
• 2: Screen script (set for a base screen)
• 3: Screen script (set for a window screen)
• 4: Script part

GD1002 Screen number
Number of the screen for which the script is set.
The device stores 0 for a project script.

GD1003 Script number or object ID number

The device stores a script number or object ID number according to the script 
type.
• For project scripts and screen scripts: script number
• For script parts: object ID number

GD1004 Execution order number

Script execution order number specified on GT Designer3
The device stores any of the following values according to the script type.
• For project scripts: 1 to 256
• For screen scripts: 1 to 256 (per screen)
• For script parts: 1 to 16 (per script parts object)

GD1005 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
If the script is set for a called screen, the device stores a value by adding a 
number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332
The device stores 0 for a project script.
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(5) List of script execution error codes

GD1006 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1007 Use prohibited The device stores 0.

Storage device Item Description

Error code Description Corrective action

1 Initialization of project script failed.
• Reduce the number of monitor devices in scripts.
• Reduce the number of project scripts to be executed.

2 Initialization of screen script (base screen) 
failed.

• Reduce the number of monitor devices in scripts and base screens.
• Reduce the number of screen scripts (base screen) to be executed.

3 Initialization of screen script (superimpose 
window 1) failed.

• Reduce the number of monitor devices in scripts and superimpose window 1.
• Reduce the number of screen scripts (superimpose window 1) to be executed.

4 Initialization of screen script (overlap window 1) 
failed.

• Reduce the number of monitor devices in scripts and overlap window 1.
• Reduce the number of screen scripts (overlap window 1) to be executed.

5 Initialization of screen script (overlap window 2) 
failed.

• Reduce the number of monitor devices in scripts and overlap window 2.
• Reduce the number of screen scripts (overlap window 2) to be executed.

6 An error occurred in reading data from the 
device that always collects the data. Correct the description of the device whose data is out of the specified device range.

7
The number of scripts to be executed exceeded 
the limit. 
And some scripts were left unexecuted.

• Change the number of scripts to be executed in one project to 256 or less.
• Change the number of scripts to be executed in one screen to 256 or less.

8
When [BCD16], [BCD32], or [BCD64] was 
selected as the script data type, the monitor 
device value could not be handled as BCD.

• Check whether the device to be monitored is correct.
• Check the processing for the device which could not be handled as BCD, and 

correct the script and sequence program.

9
When [BCD16], [BCD32], or [BCD64] was 
selected as the script data type, the operation 
result was outside the BCD data range.

Check the processing for the device that is out of the BCD data range.

10 The numerator was divided by the denominator 
of 0. Check the factor that caused zero division in the script, and correct the script.

11 Writing to a device failed. Check the device description of the script.

12 Reservation of an internal area for writing to a 
device failed. Reduce the number of devices to be written in the script.

13 The while statement includes the description of 
a device that causes an assignment delay.

Replace the device causing an assignment delay in the while statement with the 
temporary device area or a GOT internal device.

14 The expression was too complicated to 
process. Simplify or divide the operation expression in the script.

15 A script did not end within the script monitoring 
time.

• Check whether the script has gone into an endless loop.
• Increase the value of the Script Monitoring Time (GS385).

16

Access to the GOT internal device failed, 
resulting in an error (out of the specified device 
range).

• Check the processing to the GOT internal device and correct the script and 
sequence program.

• Check the description of the script.

Access to gateway device failed.
• Check that the system applications (extended functions) for the gateway function 

are installed on the GOT.
• Check the cable.

18

The number of consecutive devices handled by 
the FMOV or BMOV function exceeded the 
maximum as shown below.
• Maximum number of word devices: 32766
• Maximum number of double-word devices: 

16383
• Quad-word devices: 8191

• Reduce the number of consecutive devices handled by the FMOV or BMOV 
function.

19 Initialization of screen script (superimpose 
window 2) failed.

• Reduce the number of monitor devices in scripts and superimpose window 2.
• Reduce the number of screen scripts (superimpose window 2) to be executed.

20 The GOT failed to access a temporary device 
area because the area is invalid. Correct the descriptions of temporary device areas in the relevant script.

21 A 8-bit or 64-bit device is specified for an 
indirect device. Correct the description of the indirect device in the relevant script.

22 Temporary device areas for 32-bit data are 
used for the script of 64-bit data. Correct the common setting of the relevant script.

23
The GOT failed to access a script parts 
temporary device area because the area is 
invalid.

Correct the descriptions of script parts temporary device areas in the relevant script.
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■4 How to check a script execution record
The following shows how to check a script execution record on the GOT.

To check device values, use the device monitor function or objects (including a numerical display and lamp).

24

The GOT failed to execute the file operation 
function because data in the argument used in 
the function is invalid. (The path is invalid, the 
data is out of range, or the other errors occur.)

• Check if the argument is not out of the available range.
• Correct the folder and file names.
• Check if the storage device data and the file size are not out of the available range 

by the offset, number of write bytes, and/or number of read bytes.

25 The GOT failed to write data because the data 
storage has insufficient free space. Check the free space of the data storage.

26
The GOT failed to access the file because no 
data storage is installed or the SD card cover is 
opened.

• Check that a data storage is installed on the GOT.
• Check that the SD card cover is closed.
• Check that the SD card access switch is turned on.

27

The GOT failed to write the data because the 
data storage is write-protected, the specified 
file is a read-only file, or a file in the same name 
as the folder name in the path of the copy 
destination exists.

• Check if the data storage is not write-protected.
• Check if the specified file is not a read-only file.
• Check if a file in the same name as the folder name in the path of the copy 

destination does not exist.

28 The GOT failed to access the file because the 
data storage is not formatted or is faulty.

• Check if the data storage is formatted.
• Check if the data storage is not broken.

29 The GOT failed to access the file because the 
specified file is used for the other functions.

Check if the file which is being used by the file operation function is not used by other 
functions at the execution of the file operation function.

30
The GOT stopped copying the file because a 
file in the same name as the copy source file 
exists in the copy destination folder.

• Check if the copy destination folder has no file in the name which is the same as the 
copy source file.

• If the copy mode is write protection, disable write protection.

31
The GOT failed to execute the string operation 
function because arguments in the function 
specify invalid character strings.

• Correct the format.
• Check if the arguments are not out of the available range for specifying.

32 A 64-bit operation overflow has occurred. Check the description of the relevant script and correct it.

35 Initialization of screen script (overlap window 3) 
failed.

• Reduce the number of monitor devices in scripts and overlap window 3.
• Reduce the number of screen scripts (overlap window 3) to be executed.

36 Initialization of screen script (overlap window 4) 
failed.

• Reduce the number of monitor devices in scripts and overlap window 4.
• Reduce the number of screen scripts (overlap window 4) to be executed.

37 Initialization of screen script (overlap window 5) 
failed.

• Reduce the number of monitor devices in scripts and overlap window 5.
• Reduce the number of screen scripts (overlap window 5) to be executed.

Error code Description Corrective action

Item Description

Checking the execution status of a file 
operation function

While a file operation function is being executed, GS154.b0 is on.
After the execution is complete, GS154.b0 turns off.
The following script types are supported: project script, screen script, and script part.

Checking a script execution record
Check the script number of an executed script.
The following script types are supported: project script and screen script.

➟(1) Checking a script execution record

Checking a detailed script execution record

Check the following information on an executed script.
• Script type
• Screen number
• Script number or object ID number
• Execution order number
• Screen type
• Number of the displayed base screen
The following script types are supported: project script, screen script, and script part.

➟(2) Checking a detailed script execution record
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(1) Checking a script execution record
The following script types are supported: project script and screen script.
When a script runs, the script number is stored into the device in the range of GS49 to GS79.
GS48 stores the device number of the device where the latest script execution record is stored.
The following shows the operation of the relevant GOT internal devices.

(2) Checking a detailed script execution record
The following script types are supported: project script, screen script, and script part.
The specified GOT data registers (GD) store script execution records.
These GD devices are specified with the following GOT special registers (GS).

• GS396: Specify the start device number of the GD devices to store script execution records.
• GS398: Specify the maximum number of script execution records.

Example) When GS396 stores 1000, and GS398 stores 5

Eight word devices are used for one script execution record.
For the details of a script execution record, refer to the following.

➟(3) Details of a script execution record
To start storing script execution records, turn on GS399.b0.
You can identify the devices storing the latest script execution record based on the values of GS396 and GS158.
The following shows the operation of the relevant GOT internal devices.

• Write device

• Read device

GOT internal device Description

GS48

Stores the device number of the device where the latest script execution record is stored. The device is in the 
range of GS49 to GS79.
The value of GS48 changes as follows each time a script is executed.
-1 → 49 → 50 → 51 → 52 → ... → 79 (The next loop will start from 49.)

GS49 to GS79

Store the script numbers of the executed scripts.
One word device is used for one script.
If the number of the executed scripts is 32 or more, the script execution records are overwritten starting from 
the oldest one.

GOT internal device Description

GS158

Stores a number showing the devices where the latest script execution record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest script execution record by using 
the following expression.
• GS396 + (GS158 × 8)
Example) When GS396 stores 1000, and GS158 stores 5
1000 + (5 × 8) = 1040
In this case, GD1040 to GD1047 (eight GD devices) store the latest script execution record.

GOT internal device Description

GS396
Specify the start device number of the GD devices to store script execution records.
Data type: Unsigned binary

GS398

Specify the maximum number of script execution records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no script execution record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS399.b1 specifies the operation to be performed when the number of the executed scripts has 
exceeded the maximum number of script execution records.

GD1000 to GD1007
GD1008 to GD1015
GD1016 to GD1023
GD1024 to GD1031
GD1032 to GD1039

1st script execution record
2nd script execution record
3rd script execution record
4th script execution record
5th script execution record
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(3) Details of a script execution record
The following shows an example of how a script execution record is stored in eight word devices starting from GD1000.

GS399

b0
When this bit is turned on, storing script execution records starts.
When this bit is turned off, storing script execution records ends.

b1

Specifies the operation to be performed when the number of the executed scripts has exceeded the 
maximum number of script execution records specified with GS398.
When this bit is turned on, storing script execution records stops.
When this bit is turned off, storing script execution records continues by overwriting the oldest 
record.

b8 When this bit is turned on, the project script execution records are not stored.

b9 When this bit is turned on, the screen script execution records are not stored.

b10 When this bit is turned on, the script execution records of script parts objects are not stored.

GOT internal device Description

Storage device Item Description

GD1000 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 1: Project script
• 2: Screen script (set for a base screen)
• 3: Screen script (set for a window screen)
• 4: Script part

GD1001 Screen number
Number of the screen for which the script is set.
The device stores 0 for a project script.

GD1002 Script number or object ID number

The device stores a script number or object ID number according to the script 
type.
• For project scripts and screen scripts: script number
• For script parts: object ID number

GD1003 Execution order number

Script execution order number specified on GT Designer3
The device stores any of the following values according to the script type.
• For project scripts: 1 to 256
• For screen scripts: 1 to 256 (per screen)
• For script parts: 1 to 16 (per script parts object)

GD1004 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
If the script is set for a called screen, the device stores a value by adding a 
number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332
The device stores 0 for a project script.

GD1005 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1006 Use prohibited The device stores 0.

GD1007 Use prohibited The device stores 0.
9 - 440 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.9 Project Script, Screen Script, and Script Part



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

9.10 Object Script

9.10.1 Overview of the object script

Object scripts are settable by object.
If the trigger condition for an object script is satisfied while the relevant object is being displayed, the script runs.

9.10.2 Specifications of the object script

■1 Object script
(1) Targets for setting and operation

Object scripts are set and operate for the following objects.
• Touch switch ([Switch] only)
• [Bit Lamp]
• [Word Lamp]
• [Numerical Display]
• [Numerical Input]
• [Text Display]
• [Text Input]
• [Date Display]
• [Time Display]
• [Comment Display]
• [Line Graph]
• [Trend Graph]
• [Bar Graph]
• [Statistics Bar Graph]
• [Statistics Pie Graph]
• [Scatter Graph]
• [Historical Trend Graph]
• [Graphical Meter]
• [Level]
• [Panelmeter]
• [Parts Display]
• [Parts Movement]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Object script type
The following three types of object scripts are provided.

(a) Input object script
Scripts that are executed for objects that input numerical values.

➟9.10.4 ■1 Data operation by a numerical input script

(b) Display object script
Scripts that are executed for objects that display texts and lamps.

➟9.10.4 ■2 To start blinking after set time

(c) Switch object script
Scripts that are executed for touch switches ([Switch] only).

➟9.10.4 ■3 Showing and hiding objects for input and touch operations

(3) The GOT condition under which scripts can be executed
Object scripts can be executed when all the following four conditions are satisfied.
• The GOT is in the online process.
• The screen where the target object is placed has been displayed.
• The target object has been displayed or in operation.
• The target object has no limit on its operations by the security function.

(4) Operating conditions of scripts
Scripts are executed when the operating conditions set for each script are satisfied. The execution is also tied to: Input 
to the object, the display on the object, and a touch operation on a touch switch.

(5) Maximum number of scripts
For a single object for numerical input and character string input, both an input object script and a display object script 
can be set.
For a single object for other than numerical input and character string input, either an input object script or a display object 
script can be set.
Note that it takes longer time than usual for the monitor screen to display when the number of monitor devices in the 
object script is large.

5000

Application example): 
Changes the value to be written to a device according to 
the input value.

When -145 is written

4560

When 456 is written

Application example): 
Changes the color of numerical display and lets the value blink 
when the value is not changed for 5 seconds. 
(Notifies that a device value update has been stopped.)

759 759

Application example): 
Displays or hides a touch switch so that the switch can be touched
only when a touch operation is necessary.

123 123
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■2 Control structure of object scripts
For object scripts, the control structure of project scripts and screen scripts (except the following function) and the control 
structure described in this section are available.

For the control structure of project scripts and screen scripts, refer to the following.
➟9.9.2 ■3 Control structures for a project script, screen script, and script part

(1) Object internal variables (input object script)

Available object internal variables for input object scripts differ depending on the combination of objects and trigger types 
used.
The following shows available object internal variables.

RW: Reference or substitution is possible, R: Reference is possible, W: Substitution is possible, -: Use prohibited

Function for project and screen scripts unavailable in object scripts

Classification Name

Contiguous device operation function
bmov

fmov

Variable Description

$$

Statement example [w:D100] = $$

Function

Referred to for the script to process a monitor device value.
Values cannot be assigned.
Using $$ before the object displays the monitor device value interrupts the execution process of the script. (No 
error occurs.)
If the object is displaying the monitor device value at the subsequent script executions, $$ can be read.

Data type Data type set in the script setting

$K

Statement example [w:D100] = $K

Function
Referred to for the script to process the latest key code input from a touch key.
Assigned when a key code is written to the object.
If this variable is referred to when no key code has been input, 0xFFFF is obtained.

Data type Unsigned BIN 16

$W

Statement example [w:D100] = $W

Function
Referred to for the script to process the value input by the determination key of a touch key.
Assigned when a value is written to the object.
If this variable is referred to when no value has been input by the determination key, 0 is obtained.

Data type Data type set in the script setting

Object Trigger type
Variable

$$ $K $W $V

Numerical Input

Ordinary, ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON Sampling, 
OFF Sampling R - - -

Key Code Input R RW - -

Input Fixation R - RW -

Text Display

Ordinary, ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON Sampling, 
OFF Sampling - - - -

Key Code Input - RW - -

Input Fixation - - - -
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(2) Object internal variables (display object script)

Available object internal variables for display object scripts differ depending on the combination of objects and trigger 
types used.
The following shows available object internal variables.

RW: Reference or substitution is possible, R: Reference is possible, W: Substitution is possible, -: Use prohibited

*1 When the device type set to the object is bit data type, reference of $$ and substitution to $V are not available.
*2 [Trigger Type] cannot be set to [Synchronize Display Trigger] if the object is for date display or time display.

(3) Object internal variables (switch object script)

Available object internal variables for switch object scripts differ depending on the combination of objects and trigger 
types used.
The following shows available object internal variables.

RW: Reference or substitution is possible, R: Reference is possible, W: Substitution is possible, -: Use prohibited

Variable Description

$$

Statement example [w:D100] = $$

Function

Referred to for the script to process a monitor device value.
Values cannot be assigned.
Using $$ before the object displays the monitor device value interrupts the execution process of the script. (No 
error occurs.)
If the object is displaying the monitor device value at the subsequent script executions, $$ can be read.

Data type Data type set in the script setting

$V

Statement example $V = [w:D100]

Function Reference is unavailable.
Assigned when the value displayed on the object is changed for another one.

Data type Data type set in the script setting

Object Trigger type
Variable

$$ $K $W $V

Numerical display, numerical 
input, comment display, level 
object, parts display, parts 
movement *1

Ordinary, Synchronize Display Trigger R - - W

ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON Sampling, OFF 
Sampling R - - -

View Change R - - R

Lamp, panelmeter, graphical 
meter*1

Ordinary R - - W

ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON Sampling, OFF 
Sampling R - - -

View Change R - - R

Text Display, Text Input, Date 
Display, Time Display, Line 
Graph, Trend Graph, Bar 
Graph, Statistics Bar Graph, 
Statistics Pie Graph, Scatter 
Graph, Historical Trend Graph

Ordinary, ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON Sampling, 
OFF Sampling, View Change, Synchronize Display Trigger*2 -

Variable Description

$W

Statement example $W = [w:D100]

Function Reference is unavailable.
Assigned when a value processed in the script is used in writing with the touch switch.

Data type Data type set in the script setting

Object Trigger type
Variable

$$ $K $W $V

Touch switch ([Switch] only) Ordinary, ON, OFF, Rise, Fall, Rise/Fall, Sampling, ON 
Sampling, OFF Sampling, Device Writing - - W -
9 - 444 9. FUNCTIONS RUNNING IN THE BACKGROUND
9.10 Object Script



FU
N

C
TI

O
N

S 
R

U
N

N
IN

G
 IN

 T
H

E 
B

A
C

K
G

R
O

U
N

D

9

Using object internal variables that cannot be checked by the syntax check
In the syntax check, object internal variables in the following uses are not checked.

• In referring to an object internal variable that cannot be referred to
• In assigning a value to an object internal variable to which no value can be assigned

Use object internal variables correctly when creating scripts.

(4) Object property
For the correspondence between the read/write operation and object properties, refer to the following.

➟Object script tab of each object
For the timing of the screen reflecting after the settings of object properties, refer to the following.

➟(5) Timing at which the setting change of an object property is reflected
Changes of object properties are retained until the GOT is powered on/powered off/reset, the package data are written, 
or screen switching is performed.
The following shows the list of the object properties.

Property Description

active

Statemen
t example my.active = 1

Function

Specifies whether to update the object itself or not.
1: Updates the object itself.
0: Does not update the object itself.
The object is not updated even if the display condition is satisfied.
When "0" is specified after the screen being switched and before the object being displayed subsequently on the 
screen, the object itself is not displayed.

x

Statemen
t example my.x = 0

Function

Specifies in dots the X coordinate to which the object itself moves.
The setting range is 0 to 32767.
The left end of the screen is 0.
For a parts movement object, this property is enabled only when [Line] is selected for [Move Way] of [Move Format] 
with GT Designer3.
When the specified coordinate is outside the screen area, the object does not move.

y

Statemen
t example my.y = 0

Function

Specifies in dots the Y coordinate to which the object itself moves.
The setting range is 0 to 32767.
The upper end of the screen is 0.
For a parts movement object, this property is enabled only when [Line] is selected for [Move Way] of [Move Format] 
with GT Designer3.
When the specified coordinate is outside the screen area, the object does not move.

width

Statemen
t example [w:D100] = my.width

Function
Obtains the width of the object frame.
The setting range is 1 to 32767.

height

Statemen
t example [w:D100] = my.height

Function
Obtains the height of the object frame.
The setting range is 1 to 32767.

decimal_point

Statemen
t example my.decimal_point = 1

Function

Specifies the number of digits after the decimal point.
The setting range is 0 to 32.
This property is for a numerical display or numerical input object and enabled only when [Real] is selected for 
[Format] of [Display Format].
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blink*2

Statemen
t example my.blink = 0

Function

Specifies a blink interval and the target item for the blink.
(The setting values 129 and greater specify only objects for numerical display, numerical input, character string 
display, character string input, and comment display.)
0: No blink.
1: Lets numerical values/characters blink. (1 second intervals)
2: Lets numerical values/characters blink. (0.5 second intervals)
3: Lets numerical values/characters blink. (0.2 second intervals)
128: No blink.
129: Lets numerical values/characters and a plate blink. (1 second intervals)
130: Lets numerical values/characters and a plate blink. (0.5 second intervals)
131: Lets numerical values/characters and a plate blink. (0.2 second intervals)
Reading out my.blink after writing 128 causes the script to obtain 0.

highlight*2

Statemen
t example my.highlight = 0

Function
Specifies whether to invert the colors of characters on the object itself or not.
0: Does not invert the colors.
1: Inverts the colors.

part_no*2

Statemen
t example my.part_no = 1

Function
Specifies the part's number associated with the part to be displayed.
The setting range is 0 to 32767.

mark_color*2

Statemen
t example my.mark_color = 255

Function

When a part is displayed as a mark, specifies a color for which the white color is changed.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

frame_color

Statemen
t example [w:D100] = my.frame_color

Function

Obtains the frame color.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

plate_color*2

Statemen
t example my.plate_color = 255

Function

Specifies the plate color of the figure.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

graph_color*2

Statemen
t example my.graph_color = 255

Function

Specifies the level/needle color of the needle/color fill display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

back_color*2

Statemen
t example my.back_color = 0

Function

Specifies the background color of the meter panel display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

pattern*2

Statemen
t example my.pattern = 1

Function

Specifies a pattern.
The setting range is 1 to 37.
0: Does not use any pattern. (Use is prohibited when a panelmeter is used.)
For details of patterns, refer to the following.

➟7.5.1 [Rectangle] dialog

Property Description
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pattern_bg_color

Statemen
t example my.pattern_bg_color = 255

Function

Specifies the fill color of the meter panel display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

fill_color

Statemen
t example my.fill_color = 255

Function

Specifies the fill color of the needle/color fill display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

fill_bg_color

Statemen
t example my.fill_bg_color = 255

Function

Specifies the background color of the needle/color fill display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

fill_pattern

Statemen
t example my.fill_pattern = 1

Function

Specifies the pattern of the needle/fill display attribute.
The setting range is 1 to 37.
0: Use is prohibited.
For details of patterns, refer to the following.

➟7.5.1 [Rectangle] dialog

core_color

Statemen
t example my.core_color = 255

Function

Specifies the fill color of the middle coat display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

core_bg_color

Statemen
t example my.core_bg_color = 255

Function

Specifies the background color of the middle coat display attribute.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

core_pattern

Statemen
t example my.core_pattern = 1

Function

Specifies the pattern of the middle coat display attribute.
The setting range is 1 to 37.
0: Use is prohibited.
For details of patterns, refer to the following.

➟7.5.1 [Rectangle] dialog

text_color*2

Statemen
t example my.text_color = 255

Function

Specifies the color of numerical values/characters to be displayed.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors 
by GT Designer3.

text_width

Statemen
t example my.text_width = 1

Function

Specifies the scale factor (width) of numbers and characters the object itself displays.
0: 0.5 times
1 to 8: 1 to 8 time (s)
For HQ characters, only the setting values 2, 4, 6, and 8 can be specified.

text_height

Statemen
t example my.text_height = 1

Function

Specifies the scale factor (height) of numbers and characters the object itself displays.
0: 0.5 times
1 to 8: 1 to 8 time (s)
For HQ characters, only the setting values 2, 4, 6, and 8 can be specified.

Property Description
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arrange

Statemen
t example my.arrange = 1

Function

Select the alignment position of character strings in multiple lines.
• 0: Left justification
• 1: Right justification
• 2: Center justification

scale_max[0],
scale_max[1]*1

Statemen
t example my.scale_max[0] = 255

Function

Specifies the upper limit value of the scale.
scale_max[0] specifies the upper limit value in the horizontal direction and scale_max[1] the vertical direction.
(Range: Range of the monitor devices)

scale_min[0], 
scale_min[1]*1

Statemen
t example my.scale_min[0] = 0

Function

Specifies the lower limit value of the scale.
scale_min[0] specifies the lower limit value in the horizontal direction and scale_min[1] the vertical direction.
(Range: Range of the monitor devices)

security

Statemen
t example my.security = 0

Function

Sets the security level of the object.
The setting range is 0 to 15.
For the object that can have the security levels of both input and display set with it, this property sets the security 
level of the display.

input_security

Statemen
t example my.input_security = 0

Function
For the object that can have the security levels of both input and display set with it, this property sets the security 
level of the input.
The setting range is 0 to 15.

draw_mode

Statemen
t example my.draw_mode = 0

Function

Specifies a drawing mode.
• For numerical display, numerical input, and comment display

0: Transparent
1: XOR

• For parts display
0: Replace
1: XOR
2: Overwrite

Each drawing mode is the same as that which appears in the setting dialog of GT Designer3.

delay

Statemen
t example my.delay = 5

Function
Specifies the delay time in second the object itself takes before it performs an action after a touch.
The setting range is 0 to 5.
If 0 is set, the object itself takes the action immediately after the touch.

Property Description

AAAA
BB
CCCC

Left
justification

AAAA
BB

CCCC
Right 

justification

AAAA
BB

CCCC
Center

 justification

scale_max[1]

scale_max[0]

scale_min[1]
scale_min[0]
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*1 For a panelmeter, only scale_max[0] and scale_min[0] can be specified.
scale_max[1] or scale_min[1] cannot be specified.

*2 When the object has various status imposed, such as the on/off status of a bit and a condition, the object property is reflected 
only in the normal cases (when the bit is off or the condition is set to 0).
When the bit is on or other than 0 is set for the condition, the object property is not reflected.

(5) Timing at which the setting change of an object property is reflected
If an object property setting is changed, the object type and the object property type determine the timing at which the 
new setting is reflected.
For the correspondence between object types, object property types, and the timing at which the setting change of an 
object property is reflected, refer to the following.

➟[Script] tab in the setting dialog for each object
If an object property setting is changed, the new setting is reflected at the following timing.

(a) Upon the setting change of the object property
The object display is refreshed upon the setting change of the object property.

(b) When the object performs the specified action
The new setting is applied when the object performs the specified action.

(c) When the object is updated
The object display is refreshed or the object operates with the new setting at the following timing.

• When the "redraw_object()" function is executed
➟(8) Functions (screen control)

The object may be displayed or operate incorrectly until the new setting is reflected.
To reflect the new settings of multiple object properties, use a single "redraw_object()" function to reduce the number 
of times that the object is redrawn.

• When the display or operating condition of the object is satisfied

(d) When the screen is updated
The object display is refreshed or the object operates with the new setting at the following timing.

• When the "redraw_screen()" function is executed
➟(8) Functions (screen control)

• When screen switching is performed

beep

Statemen
t example my.beep = 0

Function

Specifies the length of the buzzer and the timing of it being made.
0: One shot
1: One shot (only when the operating condition is satisfied)
2: No buzzer
128: While a key is pressed
129: While a key is pressed (only when the operating condition is satisfied)

Property Description

my.text_height=2;
redraw_object();
my.arrange=1;
redraw_object();

my.text_height=2;

my.arrange=1;
redraw_object();
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(6) Functions (free figure drawing)

For the arguments of the free figure drawing function, refer to the following.
➟(7) Functions (arguments used for the free figure drawing function)

Function Description

d_line

Statement 
example

d_line(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Line type>, <Line width>, <Line 
color>)

Function Draws a line.
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

d_rectangle

Statement 
example

d_rectangle(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Line type>, <Line width>, 
<Line color>)

Function Draws a rectangle.
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

d_circle
Statement 
example d_circle(<X coordinate>, <Y coordinate>, <Radius>, <Line type>, <Line width>, <Line color>)

Function Draws a circle.

d_ellipse

Statement 
example

d_ellipse(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Line type>, <Line width>, 
<Line color>)

Function Draws an ellipse.
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

p_rectangle

Statement 
example

p_rectangle(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Line type>, <Line width>, 
<Line color>, <Pattern>, <Figure color>, <Background color>)

Function Draws a rectangle (color fill).
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

p_circle
Statement 
example

p_circle(<X coordinate>, <Y coordinate>, <Radius>, <Line type>, <Line width>, <Line color>, <Pattern>, <Figure 
color>, <Background color>)

Function Draws a circle (color fill).

p_ellipse

Statement 
example

p_ellipse(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Line type>, <Line width>, 
<Line color>, <Pattern>, <Figure color>, <Background color>)

Function Draws an ellipse (color fill).
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

d_textout
Statement 
example

d_textout(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Character X scale factor>, 
<Character Y scale factor>, <Character attribute>, <Character color>, <Character shadow color>, "<Text>")

Function Draws a text.

d_commentout

Statement 
example

d_commentout(<X coordinate 1>, <Y coordinate 1>, <X coordinate 2>, <Y coordinate 2>, <Character X scale 
factor>, <Character Y scale factor>, <Character attribute>, <Comment group No.>, <Comment No.>)

Function Displays a comment in a comment group.
Draws between (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 2>).

screen_draw

Statement 
example screen_draw(<screen draw flag>)

Function
Specifies the area in which drawing is executed by the free figure drawing function.
If the drawing area is not specified by screen_draw(), the drawing is executed in the object area.
The object area is equivalent to the area indicated by the coordinates shown in the data list of GT Designer3.
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(7) Functions (arguments used for the free figure drawing function)

Argument Description

<X coordinate 1>, <Y 
coordinate 1>,
<X coordinate 2>, <Y 
coordinate 2>

Specifies the area (specified by two points of (<X coordinate 1>, <Y coordinate 1>) and (<X coordinate 2>, <Y coordinate 
2>)) in which a figure is drawn in dots.
The setting range is -32768 to 32767.
(0, 0) indicates the coordinates of the upper left position of the object.
Example) Ellipse (d_ellipse())

To specify the coordinates with a rectangle (d_rectangle), ellipse (d_ellipse), rectangle (filled) (p_rectangle), or ellipse 
(filled) (p_ellipse), the following patterns are available.
• (<X coordinate 1>, <Y coordinate 1>) = Upper left, (<X coordinate 2>, <Y coordinate 2>) = Lower right
• (<X coordinate 1>, <Y coordinate 1>) = Lower right, (<X coordinate 2>, <Y coordinate 2>) = Upper left
• (<X coordinate 1>, <Y coordinate 1>) = Upper right, (<X coordinate 2>, <Y coordinate 2>) = Lower left
• (<X coordinate 1>, <Y coordinate 1>) = Lower left, (<X coordinate 2>, <Y coordinate 2>) = Upper right

<X coordinate 1>, <Y 
coordinate 1>

Specifies the coordinates of the center of a figure in dots.
The setting range is -32768 to 32767.

<Radius>
Specifies the radius of a circle in dots.
The setting range is 1 to 32767.

<Line type> *1

Selects a line type from those shown below.

<Line width> *1

Specifies a line width in dots.
The setting range is 0 to 5, 7.
The setting value 0 is available only for the color fill functions (p_rectangle, p_circle, p_ellipse).
When 0 is specified, the line is filled without the frame line displayed.

<Line color>, <Character 
color>, <Figure color>, 
<Character shadow 
color>

Specifies the color of a line, character, figure, background, and background of a character with the corresponding color 
code number.
The setting range is 0 to 255.
The correspondence between colors and color code numbers is the same as that in the specification of figure colors by 
GT Designer3.

<Pattern>

Select a color fill pattern from the following.
The setting range is 1 to 37.
0: Use is prohibited.
For details of patterns, refer to the following.

➟7.5.1 [Rectangle] dialog

<Character X scale 
factor>,
<Character Y scale 
factor>

Specifies the scale factor of a character.
Specify 2, 4, 6, or 8 when the HQ character is set for the argument <Character attribute>.
Specify 0 and 1 to 8 when the HQ character is not set.
If 0 is specified, the scale factor is 0.5.

(<X coordinate 1>, <Y coordinate 1>)

(<X coordinate 2>, <Y coordinate 2>)

0: 
1: 
2: 
3: 
4: 

Character Y scale factor

Character X scale factor
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*1 To use the circle and ellipse drawing functions (d_circle(), d_ellipse(), p_circle(), p_ellipse()), set the solid line for the line type 
and 1 dot for the line width.
When a line type other than the solid line is specified for the line type and 2 dots or more is specified for the line width, the 

<Character attribute>

Specifies the display attribute of a character.
The explanation below assumes binary notation.
When specifying in a script, change the representation meeting the applicable notation of the script, such as hexadecimal 
number.

• b1 to b0:
Select the display type of a character.
These bits can be used only for d_textout().
Specify 00 (fixed) for other functions.
00: Standard
01: Bold
10: Shadow
11: Engrave

• b2:
0 (fixed)

• b4 to b3:
Select the alignment position of character strings in multiple lines.
00: Left justification
01: Right justification
10: Center justification
11: Use prohibited

• b6 to b5:
00 (fixed)

• b7:
Select whether to use HQ characters or not.
This bit can be used only in d_commentout().
Specify 0 (fixed) for other functions.
0: Does not use HQ characters.
1: Uses HQ characters.

• b8:
0 (fixed)

• b9:
Specify a font size.
0: 16 dots
1: 12 dots

• b11 to b10:
Specify a Kanji region.
00: Japanese
01: Chinese (Simplified)
10: Chinese (Traditional)
11: Use prohibited

• b12:
Specify a font.
In d_commentout(), this bit can be used only when the use of HQ characters is specified (b7=1).
Specify 0 (fixed) when HQ characters are not used.
0: Mincho
1: Gothic

<Character> Specify a character sting in up to 256 characters.

<Comment group No.>
Specify a comment group No.
The setting range is 1 to 500.

<Comment No.>
Specify a comment No.
The setting range is 0 to 32767.

<Screen draw flag>

Specifies the area in which drawing is executed by the free figure drawing function.
0: After the execution of screen_draw(), the figure is drawn in the object area.
The object area is equivalent to the area indicated by the coordinates shown in the data list of GT Designer3.
1: After the execution of screen_draw(), the figure is drawn within the whole screen.

Argument Description

b12 b11 to 10 b9 b8 b7 b6 to 5 b4 to 3 b2 b1 to 0

Standard Bold Shadow Engrave

AAAA
BB
CCCC

Left
 justification

AAAA
BB

CCCC
Right

 justification

AAAA
BB

CCCC
Center

 justification
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circle or ellipse is drawn as shown below.
Drawing example) d_ellipse() with the dashed line for the line type and 4 dots for the line width specified

(8) Functions (screen control)
The functions (redraw_object(), clear_object()) are executed while the object script is executed.
The function (redraw_screen()) is executed at the timing of the screen being drawn after the execution of the object script.

Operator Description

redraw_object

Statement 
example redraw_object()

Function
Performs the following operations of the object itself.
1. Deletes a figure which was drawn using the free figure drawing function.
2. Redraws the object itself.

clear_object

Statement 
example clear_object()

Function

Deletes the following items.
• Data (such as numbers or characters) the object itself has displayed
• Figure drawn by the free figure drawing function of the object script for the object itself
If the object is the type that can have a plate color set, such as an object for numerical display, character string 
display, and comment display, only the frame figure is displayed.
If the object is other than those described above, the object itself is deleted.

redraw_screen

Statement 
example redraw_screen()

Function
Performs the following operations for the whole screen.
1. Deletes all figures drawn using the free figure drawing function.
2. Redraws all objects.
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■3 Available data and how to express the data
The following describes available data used for object scripts and how to express the data.
For object scripts, the data and the form of the expression that are available for project scripts and screen scripts are also 
available, as well as the data and the form of the expression described in this section.
For the data and form of the expression of project scripts and screen scripts, refer to the following.

➟9.9.2 ■4 Available data and how to express the data

(1) Available constants and how to express the constants
For object scripts, constants that are available for project scripts and screen scripts are also available, as well as the 
following constants.

(2) Object internal variables
Object internal variables are variables that have been allocated to inputs or outputs of objects.
Using object internal variables enables the following operations.
• Allowing the script to process monitor device values referring to them ($$)
• Changing the display on the object to the process result of the script ($V)
• Assigning the process result of the script with a touch switch ($W)
For reading and writing object internal variables, refer to the following.

➟9.10.2 ■2 (4) Object property
Example) In a numerical display operation, when adding the device value (GD0) to the monitor device value ($$) and 
then displaying the result on the object ($V)
$V=$$+[w:GD0];

Automatic adjustment to the decimal point
When the automatic adjustment to the decimal point is enabled, a value is processed as shown below.
(1) When a value is assigned to $V

The value which has been assigned to $V is assigned to the object as is.
(2) When a value is assigned to $W

The value which has been assigned to $W is assigned to the monitor device as is.
Example) In a numerical input operation, when the automatic adjustment to the decimal point is enabled 
and 2 is set for [Decimal Point]
• When $V=1; is executed, 1.00 is displayed for the numerical input.
• When "$W=1;" is executed, 1 is written to the monitor device.

(3) Object property
With object properties, you can refer to or change (assign) the settings of an object drawn with GT Designer3.
For the details of object properties, refer to the following.

➟Reference, substitution: Object script tab of each object
Setting: 　 9.10.2 ■2 (4) Object property

(a) Format
When using an object property in a script, prefix the object property name with "my.".
Example) Changing the character color and the blink interval of display according to the object security level
if(5<=my.security){ //If the object security level is 5 or higher
my.text_color=224; //Changes the text color to red (224).
my.blink=1; //Lets the display of the object blink at a low speed.
}else{ //If the object security level is lower than 5
my.text_color=255; //Changes the text color to white (255).
my.blink=0; //Does not let the object blink.
}

Constant Expression example

Text Enclose the text with the double quotation mark (").
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9.10.3 How to use object scripts

This section explains how to use object scripts.

■1 Setting procedure
The following shows the script settings and procedure before execution.

Step 1 Configure the settings for the script with GT Designer3, such as the data type or the trigger type.

➟9.9.5 [Script] dialog
Step 2 Create or edit the script with the script editor or a commercially available text editor.

➟9.9.7 [Edit Script(script name)] dialog
Step 3 When you have created or edited a script with a commercially available text editor, read the script with GT 

Designer3.
Step 4 Check the syntax of the script with GT Designer3.

➟9.9.7 [Edit Script(script name)] dialog
If an error is detected, return to step 1 to correct the script.
Also, using a general C language compiler can simulate the operation.
➟9.9.14 ■1 Simulation using a general C language compiler or debugger/

Step 5 Write the project from the personal computer to the GOT with GT Designer3.

➟4. COMMUNICATING WITH GOT
Step 6 Start monitoring and check the script operation using the device monitor.

➟GOT2000 Series User's Manual (Monitor)
When the script operates properly, the creation of the script is complete.
If the script runs improperly, return to step 1 to correct the script.

■2 Operation
This section explains the functions and execution of object scripts.

(1) Functions of object scripts
(a) Object internal variables

Object internal variables are variables that have been allocated to inputs or outputs of objects.
By using object internal variables, the monitor device values of an object can be operated and the operation result can be 
displayed on the object.
For the details of the object internal variables, refer to the following.

➟Types of object internal variables: 9.10.2 ■2 Control structure of object scripts
How to use: 　 9.10.2 ■3 (2) Object internal variables

(b) Object property
With object properties, you can read or change (write) the settings for an object drawn with GT Designer3.
The settings for the object on the screen can be changed automatically if the object property is changed during monitoring.
For the details of object properties, refer to the following.

➟Reading and writing: The [Operation/Script] tab or the [Script] tab of each object
Setting: 　 9.10.2 ■2 Control structure of object scripts
Expression form: 　 9.10.2 ■3 (2) Object internal variables

(c) Free figure drawing function
Figures (such as a line, rectangle, circle, and character), comments, and others can be drawn on an object.
For how to set the free figure drawing function, refer to the following.

➟9.10.2 ■2 (6) Functions (free figure drawing)
To use the free figure drawing function, execute object scripts under the operating conditions other than those described 
below.
If the free figure drawing function is executed under the following operating conditions, no figure is drawn and no error 
occurs.

• Key Code Input
• Input Fixation
• Device Writing

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.10 Object Script

9 - 455



(d) Screen Control Function
The screen control function controls redrawing or erasing of screens and objects. For the screen control function types, 
refer to the following.

➟9.10.2 ■2 (8) Functions (screen control)

(e) Script user ID
A script user ID number is an arbitrary number that is set for an object script.
If the object script causes an error, the script user ID of the object script is stored in the GOT special register (GS).
By setting different user ID numbers for all object scripts, you can identify the object script that has caused an error.

(f) Operating conditions of scripts
The execution of an object script can be tied to an input to the object, display on the object, or a touch on a touch switch, 
according to the object script type.
It is also possible for object scripts to be executed under conditions other than those described above.
For the operating conditions of object scripts, refer to the following.

➟6.2.2 Setting Trigger Types

(2) Operating condition
Object scripts are executed when all the following conditions from (a) to (d) are satisfied.
Even only one of the following conditions that is not satisfied prevents object scripts from being executed.

(a) On the screen of the GOT, the arranged target object has been displayed.
The screen on which the target object is arranged must be displayed under the condition that the GOT and controller are 
connected.

(b) The target object has been displayed or operating.
The target object must be displayed or in operation.

(c) The target object has no restriction imposed by the security function of the GOT.
When the security function is used, the object with the object script set at a high security level must not be restricted while 
it is on display or in operation.

(d) The operating condition of the script is satisfied.
The object script can be executed when the operating condition set for it is satisfied.
For the details of the script operating conditions, refer to the following.

➟6.2.2 Setting Trigger Types

(3) Execution unit
Object scripts are executed one by one.
Even when multiple operating conditions are satisfied, the scripts are not processed simultaneously.

(4) Execution order
Object scripts are executed in numerical order of object ID.

(5) Execution status
Object scripts are processed as shown below according to the script status.

*1 For details of fatal errors and execution errors, refer to the following.

➟9.9.14 ■3 Script execution errors and their corrective actions on the GOT

Script status Processing

Waiting for turn
• Waits for the processing turn according to the execution order.
• When the turn has come, the script enters the "Waiting for execution" status.

Waiting for execution

• The processing differs depending on the operating condition.
Satisfied: The script enters the "Execution" status.
Not satisfied: The script enters the "Waiting for turn" status, and the next script enters the "Waiting for 
execution" status.

Execution

• When the script has ended, the processing result is written to the PLC CPU and the script enters the "Waiting 
for turn" status.
The next script enters the "Waiting for execution" status.

• If a fatal error occurs, execution of the script stops and the script enters the "Stop" status. *1

• If an execution error occurs, execution of the script stops and the script enters the "Waiting for turn" status. *1

Stop • The "Stop" status is held until the error history is cleared.
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■3 Monitoring time of an object script
Specify the monitoring time of an object script with GS388.
If a script does not end after a lapse of the specified monitoring time, the script is aborted.
The setting range is 1 second to 300 seconds. (Units of 1 second)
If the set value falls outside this range, 10 seconds are assumed.
If error code 1015 is output during script execution, specify a longer monitoring time with GS388.

■4 Running an object script upon an applicable process
Use GS389 to set whether to run an object script upon screen switching or other applicable processes.
When GS389 stores 0: Runs the script upon an applicable process.
When GS389 stores a nonzero value: Does not run the script upon an applicable process.
This setting is applied to the object scripts where the following trigger types are set.

When the object script ([Trigger Type]: [Rise], [Trigger Device]: X1000) is set for a switch on base screen 2

The following shows the processes upon which a script runs.

*1 When [Perform script initial operation (screen/object) only when switching screens] is deselected on the [Option] tab in the 
[Script] dialog, the script runs upon the process.

➟9.9.5 ■4 [Option] tab

Trigger type When running a script upon an applicable process

[Rise] When the trigger device is on, the script runs upon screen switching or other applicable processes.

[Fall] When the trigger device is off, the script runs upon screen switching or other applicable processes.

[Rise/Fall] When the trigger device is on or off, the script runs upon screen switching or other applicable 
processes.

Process Remarks

When the GOT is powered on or when 
the GOT returns from offline -

Screen switching The script set for the destination screen runs.

Security switching *1 -

Language switching *1 -

System language switching *1 -

Station No. switching *1 If a station No. switching device is set for a screen type, the script set for a screen of this type runs.

Screen switching

Trigger device
(X1000)

Screen switching device
 (for base screens)

When GS389 stores a nonzero value, the script does not run.

ON

OFF

1 2

When GS389 stores 0, the script runs
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9.10.4 Program examples of object scripts

This section explains program examples of object scripts.

■1 Data operation by a numerical input script
(1) Operation

Data operation is performed when a device value is written.

(2) Program example

■2 To start blinking after set time
(1) Operation

A displayed value (monitored device value) blinks when it does not change for set time.
This operation is useful when urging the use of caution is necessary after set time.

(2) Program example

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Screen image Operation of each object

Numerical input: When the written value is 0 or greater, the written value is 
multiplied by 10. When the written value is less than 0, the written value is 
set to 5000.

Item Description

Data type Signed BIN 16

Trigger type Input Fixation

Script

[w:TMP0] = $W;
if([w:TMP0] >= 0) {
$W = [w:TMP0] * 10;
}else{
$W = 5000;
}

//Stores the written value to the temporary area.
//If the written value is 0 or greater,
//the written value is multiplied by 10.
//If the written value is less than 0,
//the written value is set to 5000.

Screen image Operation of each object

Numerical display:
If the displayed value (monitored device value) does not change for 5 
seconds, the characters blink in red.

Item Description

Data type Signed BIN 16

Trigger type Cycle (1 second)

Script

if([w:TMP0002] != $$){
[w:TMP0001] = 5;
[w:TMP0002] = $$;
my.blink = 0;
my.text_color = 0xFF;
}else{
if([w:TMP0001] > 0){
[w:TMP0001] = [w:TMP0001] - 1;
if([w:TMP0001] == 0){
my.text_color = 0xE0;
my.blink = 3;
}
}else{
[w:TMP0001] = 5;
}
}
redraw_object();

//If the displayed value changes,
//starts counting (sets time (seconds) when the blinking starts).
//saves the displayed value.
//sets so that blinking is not performed.
//changes the character color to white.
//If the displayed value does not change,
//If the count is not 0,
//starts counting down.
//If counting down to 0,
//changes the character color to red.
//starts high-speed blinking.
//Lets the object reflect this property.
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■3 Showing and hiding objects for input and touch operations
(1) Operation

At screen switching, objects for specific input and touch operations are switched between being displayed and hidden 
according to the operating conditions.
Since objects used for input and touch operations are displayed only when necessary, this operation is useful for avoiding 
a wrong input.

(2) Monitor screen setting

(3) Program example
Numerical input

Switch 1 switch

Screen image Operation of each object

Numerical input:
If M0 turns on, the object for numerical input is displayed.
If M0 turns off, the object for numerical input is hidden.
Switch 1 switch:
If M1 turns on, the touch switch is displayed.
If M1 turns off, the touch switch is hidden.

Object name Type Setting item Setting

Numerical input Numerical input Display condition, operating 
condition

Trigger type ON

Trigger device M0

Switch 1 Switch Operating condition
Trigger type ON

Trigger device M1

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if([b:M0] == ON){
my.active = 1;
redraw_object();
}else{
my.active = 0;
clear_object();
}

//Enables an update.
//Updates the object.
//Disables an update.
//Clears the object.

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if([b:M1] == ON){
my.active = 1;
redraw_object();
}else{
my.active = 0;
clear_object();
}

//Enables an update.
//Updates the object.
//Disables an update.
//Clears the object.
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■4 Drawing according to a device value
(1) Operation

A figure is drawn on the screen according to a device value.

(2) Monitor screen setting

Screen image Operation of each object

Operation 1 lamp: Turns on if D500 is 1 and a circle is drawn around the 
lamp.
Operation 2 lamp: Turns on if D500 is 2 and a circle is drawn around the 
lamp.
Operation 3 lamp: Turns on if D500 is 3 and a circle is drawn around the 
lamp.
Reset switch:
Resets operation 1 to operation 3.
Operation 1 switch to operation 3 switch:
Starts operation 1 to operation 3.

Object name Type Setting item Setting

Operation 1 lamp Word lamp

Device D500

Text Operation 1

Condition 0 Lamp color Red

Condition 1
Range $V<1

Lamp color Black

Operation 2 lamp Word lamp

Device D500

Text Operation 2

Condition 0 Lamp color Red

Condition 1
Range $V<2

Lamp color Black

Operation 3 lamp Word lamp

Device D500

Text Operation 3

Condition 0 Lamp color Red

Condition 1
Range $V<3

Lamp color Black

Reset switch Word switch

Device D500

Set value (fixed) 0

Text Reset

Operation 1 switch Word switch

Device D500

Set value (fixed) 1

Text Operation 1

Operation 2 switch Word switch

Device D500

Set value (fixed) 2

Text Operation 2

Operation 3 switch Word switch

Device D500

Set value (fixed) 3

Text Operation 3
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(3) Program example
Operation 1 lamp

Operation 2 lamp

Operation 3 lamp

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if ([w:D500] == 1){
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 224);
}else{
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 255);
}

//If D500 is 1,
//sets the drawing area to the whole screen.
//draws a circle.
//If D500 is not 1,
//sets the drawing area to the whole screen.
//deletes a circle. (draws a circle in the same color as the 
background color.)

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if ([w:D500] == 2){
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 224);
}else{
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 255);
}

//If D500 is 2,
//sets the drawing area to the whole screen.
//draws a circle.
//If D500 is not 2,
//sets the drawing area to the whole screen.
//deletes a circle. (draws a circle in the same color as the 
background color.)

Item Description

Data type Signed BIN 16

Trigger type Always

Script

if ([w:D500] == 3){
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 224);
}else{
screen_draw(1);
d_circle(57, 52, 65, 0, 2, 255);
}

//If D500 is 3,
//sets the drawing area to the whole screen.
//draws a circle.
//If D500 is not 3,
//sets the drawing area to the whole screen.
//deletes a circle. (draws a circle in the same color as the 
background color.)
9. FUNCTIONS RUNNING IN THE BACKGROUND
9.10 Object Script

9 - 461



9.10.5 [Object Script Symbol] dialog

This dialog is used for setting an object script.
Select [Common] → [Script] → [Object Script Symbol] from the menu to display the setting dialog.
Register character strings as script symbols.
Devices and constants in a script can be substituted by the registered character strings.
This setting is enabled only for the object script.

1) [Add] button
This button is available when [Skip blank rows] is selected.
Displays the [Add Object Script Symbol] dialog.

2) [Copy] button
Copies the setting from the row selected in the script symbol list.
You can copy the settings from multiple rows at one time.
When [Skip blank rows] is selected, the settings in the hidden rows are also copied.
The copied settings can be pasted to another script symbol setting dialog.

3) [Paste] button
Pastes the copied setting to the selected row.

• [No.]
Set a number for the script symbol to be added.
The setting range is [1] to [10000].

• [Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

• [Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

4)1) 2)

7)

3) 5) 6)

8)

9)
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When [Skip blank rows] is selected, the [Paste Symbol] dialog is displayed.

4) [Delete] button
Deletes the setting from the selected row.
You can delete the settings from multiple rows at one time.

5) [Import] button
Displays the [Open] dialog.
Read the script symbol settings from a Unicode text file or CSV file.

6) [Export] button
Displays the [Save As] dialog.
Save the script symbol settings to a Unicode text file or CSV file.
If multi-language characters are used in the settings, use the Unicode text file format.
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

7) [Skip blank rows]
Displays only the rows in which script symbols have been registered.

8) Script symbol list
Lists the registered script symbols.
[Symbol Name] and [Device and Constant] are editable.

9) [Insert] button
This item appears when this dialog is brought up from the [Edit Script(script name)] dialog.
Inserts the selected script symbol into the script edit area in the [Edit Script(script name)] dialog.

(1) Editing method of scripts
You can edit scripts in the exported Unicode text file or CSV file using spreadsheet software and other 
software.
The edited Unicode text file or CSV file can be imported and read to GT Designer3.

(2) Editing the exported file
When 0 is set at the beginning of the symbol name, device, or constant, 0 at the beginning may be 
deleted depending on the function of the application for editing files (spreadsheet software and other 
software).
Pay attention to the above for editing exported files.

• [Symbol No.]
Set a symbol number for the destination row.
The setting range is [1] to [10000].

• [First Symbol No.]
Set a symbol number for the first destination row.
The setting range is [1] to [10000].

Item Description

[No.]
Row number.
Clicking a row number selects the relevant row.

[Symbol Name]
Set a character string to be described in a script.
Up to 32 alphanumeric characters and symbols can be entered.
However, the symbol # is not usable.

[Device and Constant]
Set a device or constant for the symbol name.
Up to 32 alphanumeric characters and symbols can be entered.

When pasting a setting to one row

When pasting settings to multiple rows
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Example) When script settings are exported into and imported from a CSV file

Edit the exported file.

Export the set script symbols to a CSV file.

Import from the CSV file to GT Designer3.

Add settings using applications
such as spreadsheet software.

The added settings are reflected.
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9.10.6 How to set object scripts

➟■1 [Script] or [Operation/Script] tab for input object scripts
■2 [Script] or [Operation/Script] tab for display object scripts
■3 [Script] tab for switch object scripts

Step 1 Double-click an arranged object to display the setting dialog.

Step 2 Open the [Script] or [Operation/Script] tab to configure the setting for using the object script.

The setting of the [Script] or [Operation/Script] tab differs depending on the object type.
For the details of the setting of the [Script] or [Operation/Script] tab for each object, refer to the following.

■1 [Script] or [Operation/Script] tab for input object scripts

Object script type Target object Reference

Input object script Numerical input, Character string input ➟■1 [Script] or [Operation/Script] tab for input object 
scripts

Display object script

Bit lamp, word lamp, numerical display, numerical input, text 
display, text input, date display, time display, comment 
display, line graph, trend graph, bar graph, statistics bar 
graph, statistics pie graph, scatter graph, historical trend 
graph, graphical meter, level object, panelmeter, parts 
display, parts movement

➟■2 [Script] or [Operation/Script] tab for display 
object scripts

Switch object script Touch switch ([Switch] only) ➟■3 [Script] tab for switch object scripts

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Double-click

[Operation/Script] tab of numerical input

Screen in setting an input object script for numerical input

1)

2)
3)
4)

5) 6)

7)
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1) [Input] button
To set an input object script, click the [Input] button.
Then, the setting items of the input object script are displayed.
This button is displayed only for the following objects.

• [Numerical Input]
• [Text Input]

2) [Use Object Script]
Enables the object script.

3) [Script User ID]
Set the script user ID number.
The setting range is [1] to [65535].
Set the script user ID number which is different from that of other object scripts.
When a different number is set, the object script in which an error has occurred can be identified.

4) [Data Type]
Select the data type of the script to be executed.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

5) [Trigger Type], [Trigger Device]
Displays the operating condition and trigger device of the script which are set in the [Trigger Setting] dialog.

6) [Trigger Setting] button
Click the [Trigger Setting] button to display the [Trigger Setting] dialog.

*1 For the precautions for selecting [ON], [OFF], [Sampling], [ON Sampling], or [OFF Sampling], refer to the following.

➟9.10.7 ■8 Precautions when making a script perform its operation periodically
*2 When the trigger condition is satisfied, the count of the cycle starts.

When [ON Sampling] is set and the cycle is set to 10 seconds, the script is executed 10 seconds after the device set in [Trigger 
Device] turns on. (When [Trigger Device] turns off within 10 seconds, the script is not executed.)
When the trigger condition is not satisfied, the count of the cycle is reset.
➟6.2.2 Setting Trigger Types

7) [Script]
Displays the content of the script.
You can edit the script.

• [Trigger type]
Select the operating condition of the script.
The following shows the items to be selected.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [Key Code Input]
• [Input Fixation]

• [Settings]
Set the trigger device which executes the script. (When 
[ON], [OFF], [Rise], [Fall], [Rise/Fall], [ON Sampling], or 
[OFF Sampling] is selected in [Trigger type])
When [Sampling], [ON Sampling], or [OFF Sampling] is 
selected, set the cycle in units of seconds.
The setting range is [1] to [3600]. *2
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After editing the script, click the [Syntax Check] button to check the syntax.

■2 [Script] or [Operation/Script] tab for display object scripts

1) [Display] button
To set an input object script, click the [Display] button.
Then, the setting items of the input object script are displayed.
This button is displayed only for the following objects.

• [Numerical Input]
• [Text Input]

2) [Use Object Script]
Enables the object script.

3) [Script User ID]
Set the script user ID number.
The setting range is [1] to [65535].
Set the script user ID number which is different from that of other object scripts.
When a different number is set, the object script in which an error has occurred can be identified.

4) [Data Type]
Select the data type of the script to be executed.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

Item Description

[Edit Script] button
Opens the editor to edit the script.

➟9.9.7 [Edit Script(script name)] dialog

[Syntax Check] button
Checks the syntax of the displayed script.
The available device type and device range are also checked.

➟9.10.9 ■2 Messages to be displayed at the syntax check

Screen in setting a display object script for numerical input

1)

2)
3)
4)

5) 6)

7)
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5) [Trigger Type], [Trigger Device]
Displays the operating condition and trigger device of the script which are set in the [Trigger Setting] dialog.

6) [Trigger Setting] button
Click the [Trigger Setting] button to display the [Trigger Setting] dialog.

*1 For the precautions for selecting [ON], [OFF], [Sampling], [ON Sampling], or [OFF Sampling], refer to the following.

➟9.10.7 ■8 Precautions when making a script perform its operation periodically
*2 This item is unavailable for the bit lamp, word lamp, date display, time display, graphical meter, and panelmeter.
*3 When the trigger condition is satisfied, the count of the cycle starts.

When [ON Sampling] is set and the cycle is set to 10 seconds, the script is executed 10 seconds after the device set in 
[Trigger Device] turns on. (When [Trigger Device] turns off within 10 seconds, the script is not executed.)
When the trigger condition is not satisfied, the count of the cycle is reset.
➟6.2.2 Setting Trigger Types

7) [Script]
Displays the content of the script.
You can edit the script.
After editing the script, click the [Syntax Check] button to check the syntax.

• [Trigger type]
Select the operating condition of the script.
The following shows the items to be selected.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [View Change]

• [Synchronize Display Trigger]*2

• [Settings]
Set the trigger device which executes the script. (When 
[ON], [OFF], [Rise], [Fall], [Rise/Fall], [ON Sampling], or 
[OFF Sampling] is selected in [Trigger type])
When [Sampling], [ON Sampling], or [OFF Sampling] is 
selected, set the cycle in units of seconds.
The setting range is [1] to [3600]. *3

Item Description

[Edit Script] button
Opens the editor to edit the script.

➟9.9.7 [Edit Script(script name)] dialog

[Syntax Check] button
Checks the syntax of the displayed script.
The available device type and device range are also checked.

➟9.10.9 ■2 Messages to be displayed at the syntax check
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■3 [Script] tab for switch object scripts

1) [Use Object Script]
Enables the object script.

2) [Script User ID]
Set the script user ID number.
The setting range is [1] to [65535].
Set the script user ID number which is different from that of other object scripts.
When a different number is set, the object script in which an error has occurred can be identified.

3) [Data Type]
Select the data type of the script to be executed.
The following shows the items to be selected.

• [Signed BIN16]
• [Unsigned BIN16]
• [Signed BIN32]
• [Unsigned BIN32]
• [Signed BIN64]
• [Unsigned BIN64]
• [BCD16]
• [BCD32]
• [BCD64]
• [Real(32bit)]
• [Real(64bit)]

4) [Trigger Type], [Trigger Device]
Displays the operating condition and trigger device of the script which are set in the [Trigger Setting] dialog.

5) [Trigger Setting] button

1)
2)
3)

4)

6)

5)

7)
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Click the [Trigger Setting] button to display the [Trigger Setting] dialog.

*1 For the precautions for selecting [ON], [OFF], [Sampling], [ON Sampling], or [OFF Sampling], refer to the following.

➟9.10.7 ■8 Precautions when making a script perform its operation periodically
*2 When the trigger condition is satisfied, the count of the cycle starts.

When [ON Sampling] is set and the cycle is set to 10 seconds, the script is executed 10 seconds after the device set in [Trigger 
Device] turns on. (When [Trigger Device] turns off within 10 seconds, the script is not executed.)
When the trigger condition is not satisfied, the count of the cycle is reset.
➟6.2.2 Setting Trigger Types

6) [$W (Write Device)]
To assign the value processed in the script to the device with the touch switch, set the target device.

7) [Script]
Displays the content of the script.
You can edit the script.
After editing the script, click the [Syntax Check] button to check the syntax.

• [Trigger type]
Select the operating condition of the script.
The following shows the items to be selected.
• [Ordinary]
• [ON]
• [OFF]
• [Rise]
• [Fall]
• [Rise/Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]
• [Device Writing]

• [Settings]
Set the trigger device which executes the script. (When 
[ON], [OFF], [Rise], [Fall], [Rise/Fall], [ON Sampling], or 
[OFF Sampling] is selected in [Trigger type])
When [Sampling], [ON Sampling], or [OFF Sampling] is 
selected, set the cycle in units of seconds.
The setting range is [1] to [3600]. *2

Item Description

[Data type] Select the data type of the object internal variable $W (write device).

[Device]
Set the object internal variable $W (write device).

➟6.1 Device Settings

Item Description

[Edit Script] button
Opens the editor to edit the script.
• 9.9.6 [Script Editor (Script Name)] dialog

[Syntax Check] button
Checks the syntax of the displayed script.
The available device type and device range are also checked.

➟9.10.9 ■2 Messages to be displayed at the syntax check
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9.10.7 Precautions

This section explains the precautions for using object scripts.

■1 Precautions for use
(1) Applicable range of the scripts

Since this function is designed to control the GOT display, do not use it for machine control that requires precise time 
management.
When changing the data in PLC through the GOT, create an interlock circuit using a sequence program to ensure the 
whole system can always operate safely.
The following periods may vary depending on projects.
• The period between when the trigger device condition of the script is satisfied and when the script is actually executed
• Processing time of the script

(2) Stop of the script processing
In any of the following cases, the corresponding script being processed stops and an error occurs.
• In division, when the divisor becomes 0 and the calculation becomes zero division
• When [BCD16], [BCD32], or [BCD64] is selected as the script data type but a value of the monitor device cannot be 
handled as BCD

• When [BCD16], [BCD32], or [BCD64] is selected as the script data type but the operation result is out of the BCD range
• When a device of the controller is specified as the write destination device of a while statement
For the available data type and data range, refer to the following.

➟9.10.2 ■3 Available data and how to express the data
For the details of the while statement, refer to the following.

➟9.10.2 ■2 Control structure of object scripts
For troubleshooting the script processing stop, refer to the following.

➟9.10.9 Troubleshooting

(3) Variation of the result of processing depending on data types
In the following cases, you may get an unexpected result of processing.
• When a data type other than [BCD16], [BCD32], or [BCD64] is selected as the script data type but a constant out of the 
selected type range is included

• When [Unsigned BIN16] or [Unsigned BIN32] is selected as the script data type but a negative constant is included
• When a data type other than [Real] is selected as the script data type but a value with the decimal point is used as a 
constant

For the details of data types, refer to the following.
➟9.10.2 ■3 Available data and how to express the data

(4) Bitwise operation and data type
If you perform a bitwise operation on the device with a signed data type, an unexpected value may result.
Set an unsigned data type for the target device of a bitwise operation.

(5) Digit limitation when describing monitor devices
Depending on controllers to be monitored, the device number for them must be described in specific digits.
Otherwise, malfunction may result.
For the details of how to describe the device number, refer to the following.

➟9.10.2 ■3 Available data and how to express the data

(6) Writing the project in the GOT after editing the script
If you edit a screen script or an object script, write the project being edited in the GOT.
Otherwise, the change you made is not reflected to the GOT.

(7) Operation while a script is being edited
When you click the [Edit Script] button and edit a script using a script editor or a text editor, you cannot operate GT 
Designer3.
GT Designer3 reacts as if it freezes up then, but once you close the script editor or the text editor, you can operate GT 
Designer3 again.
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(8) Precautions for assignment delay
(a) Assignment delay

Depending on devices where you write the operation result of scripts, some time (called assignment delay) is needed for 
writing the result to the device when the operation of a script is complete.
The following shows whether each device needs assignment delay or not.

Synchronized: The result is written in synchronization with the script. Delay: Assignment delay occurs.

If you perform an assignment as shown in example 1, an assignment delay leads to an unexpected operation 
result.
To reduce the frequency of communication with the PLC CPU to lower the influence on the monitoring process, 
describe the script as shown in example 2 or 3.

Example 1) Assignment using PLC CPU devices (assignment delay example)
In the following example, due to an assignment delay, after the script ends, the operation result of the first line 
(D0+1) is reflected to D1.
Therefore, the operation result of the first line is not reflected to that of the second line (D1*2).

Example 2) Assignment using a temporary device area (assignment delay workaround 1)
Using a temporary device area for the script avoids an assignment delay.
For the details of temporary device areas, refer to the following.

➟9.9.2 (10) Temporary device areas and their uses

Device and temporary device area
Script

Object script

Controller device Delay

GB

Synchronized
GD

GS

TMP

D0 100 100

200 101

300 400

D1

GD100

[w:D0] + 1

[w:D1] * 2

Script starts. Script ends.

[w:D1] = [w:D0]+1   // Assign the operation result of D0+1 to D1.
[w:GD100]＝[w:D1]*2   // Assign the operation result of D1*2 to GD100

[w:TMP0001] = [w:D0]+1;  // Assign the operation result of D0+1 to TMP0001.
[w:D1] = [w:TMP0001];  // Assign the value of TMP0001 to D1.
[w:GD100] = [w:TMP0001]*2;  // Assign the operation result of TMP0001*2 to GD100.

D0 100 100

200 101

300 202

D1

GD100

[w:TMP0001]=[w:D0] + 1

[w:D1]=[w:TMP0001]

[w:GD100]=[w:TMP0001] * 2

Script starts. Script ends.
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Example 3) Assignment using GOT internal devices (GD, GB) (assignment delay workaround 2)
The processing timing with GOT internal devices (GD and GB) is the same as one with temporary device areas. Therefore, 
you can avoid assignment delays.

(1) LS devices specified in a script created using SCHNEIDER EJH software
The LS devices specified in the script language of SCHNEIDER EJH software are designed to be free 
from assignment delays.
Therefore, when a script including LS devices shown in example 1 above is converted, the converted 
script may not run as intended on the GOT.
To prevent an assignment delay, use temporary device areas for scripts including LS devices as shown 
in example 2 above.

(b) Assignment delay when an offset is specified
• When reading values from devices

If you specify an offset in a script when devices of controllers are used as base devices, assignment delays may 
occur and the script may not operate correctly even if the values of offset devices are changed.

Example 1) Specifying a target device for reading with an offset device does not work correctly (when R200 = 10)
In the following case, the value of the offset device (TMP0000) is the value before assignment. The value of R110 
cannot be referenced.

If the "value of R100 + offset device value before assignment" is outside the range of the base device (R), an error 
other than an assignment delay occurs.

To avoid assignment delays, use temporary device areas or GOT internal devices (GD, GB) for both base devices 
and offset devices.
Example 2) Measure to avoid the assignment delay using temporary device areas (when R200 = 10)
By assigning the values of R devices to the temporary device areas in advance, the operation not available in 
example 1 becomes available.
In the following example, values of the offset device (R200) range from 0 to 10, and the values of 11 devices counted 
from the base device (R100) are assigned to the temporary device areas.
The number of devices to be assigned to the temporary device areas must be changed according to the range of 
offset device values.

• When writing values to devices
When writing values to devices, there are no specific restrictions applied when reading values from devices. (Refer 
to the following example 1.) 
Example 1) Specifying a target device for writing with an offset device (Enabled)

[w:GD10]＝[w:D0]+1;  // Assign the operation result of D0+1 to GD10.
[w:D1]＝[w:GD10];   // Assign GD10 to D1.
[w:GD100]＝[w:GD10]*2;   // Assign the operation result of GD10*2 to GD100.

[w:TMP0000]=[w:R200]; 
[w:TMP0001]=[w:R100[w:TMP0000]];    The value of R110 cannot be referred at this timing.

Offset device Base device

[w:TMP0100]=[w:R100];
[w:TMP0101]=[w:R101];
:
[w:TMP0109]=[w:R109];
[w:TMP0110]=[w:R110];
[w:TMP0000]=[w:R200];
[w:TMP0001]=[w:TMP0100[w:TMP0000]];     The value of R110 can be referred at this timing.

[w:TMP0000]=10; 
[w:R100[w:TMP0000]]=[w:TMP0001];    The value can be assigned to R110 at this timing.        

Offset device Base device
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However, when controller devices are used as base devices, you cannot assign values repeatedly by switching 
values of offset devices in a while statement as shown in example 2.
Example 2) Specifying a target device for writing with an offset device in a while statement (Disabled)

To assign values repeatedly by switching offset device values in a while statement, assign R devices to the temporary 
device areas in advance, and write the values last assigned to the temporary device areas to R devices as shown in 
example 3 below.
Example 3) Measure to avoid the error in example 2

(9) Simulating using a general C language compiler or debugger
• If [BCD32], [BCD16], or [BCD64] is selected as the script data type, you cannot perform a simulation using the general 
C language compiler or debugger.

• Since the set, rst, alt, bmov, and fmov statements are dedicated for scripts, you cannot perform a simulation using a 
general C language compiler or debugger.
Use assignment of 1 or 0 instead of the set or rst statement.

• When you use the system define (ON, OFF description) of the GOT as they are, the define for it must be added to the 
C language source file.

• The assignment delay which occurs when a script is executed on the GOT does not occur during a simulation using a 
general C language compiler or debugger.
Therefore, when performing a simulation, take a possibility of occurrence of assignment delays into consideration.

• By applying the measures above, a new program created using C language then debugged can be used as a GOT 
script.

• Offset device specification cannot be made in the above debugging process.
If you debug the offset specified device, it is necessary to set the corresponding device in advance.

(10)Object script error control and GOT status
While the GOT displays any screen other than a user-created screen, the following operations are not available.
• Clearing object script error data or executing an object script stopped due to an error by using the Object Script Common 
Control (GS387)

➟12.1.3 ■5 (4) Object Script Common Control (GS387)
• Resetting object script error data in the [GOT Diagnostics] dialog

➟11.14.5 [GOT Diagnostics] dialog
Perform the above operations while the GOT displays a user-created screen.

■2 Precautions for drawing
If you close the setting dialog clicking the [OK] button after changing numerical input for numerical display or character string 
input for character string display, the input object script settings are cleared.
Only the display object script settings remain.

■3 Precautions for the operating conditions of object scripts
(1) Functions that cannot be set simultaneously

When any of the following functions is set, object scripts cannot be used.
To use object scripts, do not set the following functions.

[W:TMP0000]=10; 
while([w:TMP0000]<20){ 
[W:R100[w:TMP0000]]=[w:TMP0001];           An error occurs. 
[W:TMP0000]=[w:TMP0000]+2;
}

[w:TMP0110]=[w:R110];
:
[w:TMP0119]=[w:R119];
[w:TMP0000]=10;
while([w:TMP0000]<20)｛
[w:TMP0100[w:TMP0000]]=[w:TMP0001];        No error occurs.
[w:TMP0000]=[w:TMP0000]+2;
｝
[w:R110]=[w:TMP0110];
:
[w:R119]=[w:TMP0119];
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• Data operation
• Memory storage

(2) Object status
You cannot execute an object script when it is in either of the following statuses.
• The object is not displayed or operated because it has been extending off the screen.
• The object is not displayed or operated because no monitor device has been set.

(3) Executing an object script for the same window from multiple sources
When the same window is displayed from multiple sources including an overlap window, a superimpose window, and the 
overlay screen function, only the object script for the window that is displayed first is executed.
Even if the window displayed first is deleted, the object scripts for the windows displayed after the first one are not 
executed.
If, in the above situation, the same window is newly displayed from an overlap window, a superimpose window, or the 
overlay screen function, the object scripts for the multiple windows which are the same and have been already displayed 
are not executed but the object script for the new window is executed.

(4) When setting the operating trigger to the timing of writing to a device
Set the target device for the write operation for the object that has the script set for it.
Otherwise, the script is not executed.

■4 Precautions for devices
(1) Number of writable devices

If the following type of devices is the target for writing, a single script can perform a single write operation of the type.
• Controller device
If the following types of devices are the targets for writing, a single script can perform the write operation of each type.
• GOT bit register (GB)
• GOT data register (GD)
• GOT special register (GS)
• Temporary device area (TMP)

(2) Operation while data are being written to devices by an object script
• The execution process of the script is interrupted temporarily, and resumed after the completion of the write operation.
Interrupted operation restarts after the completion of write device.

• The display on the object is updated after the completion of the write operation.
Object display is updated after the completion of write device.

• Inputting a value by touching the object on the screen is enabled after the completion of the write operation.
Input is enabled after the completion of write device.

■5 Precautions for object properties
(1) The numerical display or comment display movement on the GOT when a level is overlaid

If the objects are drawn with GT Designer3 so that the level can be overlaid, the numerical display or comment display 
correctly works only when it can be moved within the range of the level display.
If you move the numerical display or the comment display out of the area of the level display, the numerical display or the 
comment display cannot be displayed normally.
If you draw the numerical display or comment outside the area of the level display with GT Designer3, the numerical 
display or comment display is not superimposed even it is moved into the area of the level display.

(2) Properties that are not valid unless enabled by GT Designer3 settings
Among the setting items of objects, those which become valid only by GT Designer3 settings (such as the settings which 
are not valid unless another item is selected) cannot be referred or changed by the object properties.

■6 Precautions for the free figure drawing function
(1) Restrictions when the object stacking order adjustment setting is made

When [Adjust object display order in GOT to the one in GT Designer3] is selected in the [Type Setting] dialog, some 
restrictions are placed on the free figure drawing function.
For the details of the restrictions, refer to the following.

➟5.1.4 ■5 Precautions for the object stacking order adjustment setting

(2) Overlap of a drawn figure and an object
If a figure drawn using the free figure drawing function overlaps with an object, the part of the figure that overlaps may 
disappear.
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(3) Drawing when other than [View Change] and [Synchronize Display Trigger] are set for the operating 
condition
When the operating condition is other than [View Change] and [Synchronize Display Trigger], the object itself is 
overwritten and replaced with the figure drawn by the free figure drawing function. Therefore, the figure drawn by the free 
figure drawing function may be cleared.

(4) When [Key Code Input], [Input Fixation], or [Device Writing] is set for the operating condition
Drawing is not executed.
In this case, no error occurs.
When using the free figure drawing function, set other than [Key Code Input], [Input Fixation], and [Device Writing] for the 
operating condition.

(5) Number of drawable figures
Up to 1280 figures can be drawn by one object script.

If the number of drawn figures exceeds 1280, the oldest figure is deleted and a new figure is drawn.
The maximum number of the text figures drawn with the d_textout or d_commentout function differs depending on the 
number of lines in the text figure.
Example)

• One-line text: 1280 figures
• Two-line text: 640 figures

More than 1280 figures cannot be drawn.

(6) Drawing area
In the coordinate system with (0, 0) at the upper left corner of the GOT screen, figures cannot be drawn outside the area 
of (-2400, -2400) to (4799, 4799).
Specify coordinates inside the area of (-2400, -2400) to (4799, 4799) to draw figures.

■7 Precautions when writing a script
Do not write a script that causes an operation result which exceeds the allowable range of a device value.
Script operation is processed internally in double-precision real numbers.
Therefore, when a judgment is made using an if statement and others, the result of the judgment may differ depending on 
the operation methods.
Example) Judgment for the difference between GD100 and D100 using an if statement (in the case of 16-bit signed binary)
When GD100 = -32758 and D100 = 32767

(1) Operation in an evaluation expression
if(([w:GD100]-[w:D100])>=10){  //If the difference between GD100 and D100 is 10 or larger,
     [w:D200=0;                           //Writes 0 to D200.
}
The calculation result of "GD100 - D100" (-32758 - 32767) is -65525, thus the condition is not satisfied.

(2) Processing the script after assignment
[w:GD200]=[w:GD100]-[w:D100];  //Assigns the value of "GD100 - D100" to GD200.
if([w:GD200]>=10){                      //When the value of GD200 is 10 or larger,
    [w:D200=0;                              //Writes 0 to D200.
}
When -65525; the calculation result of "GD100 - D100" (-32758 - 32767), is assigned to GD200 in 16-bit signed binary, 
GD200 becomes 10, so the condition is satisfied.
(Since a value out of the range that can be handled by a variable (device) is assigned as the result of an operation, the 
result differs from the result obtained in (1).)

GOT Graphic Ver.2

GOT Graphic Ver.1

(-2400, -2400)

(4799, 4799)

(0, 0)
Figures can be drawn inside the frame.

Figures cannot be drawn outside the frame.
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■8 Precautions when making a script perform its operation periodically
(1) Execution timing when [Trigger Type] is set to [ON Sampling] or [OFF Sampling]

➟9.10.6 How to set object scripts

(a) Execution timing
The device status is checked in the sampling cycles set for [Trigger Type].
If the condition is not satisfied at the timing of the check, the object script is not executed.
(when [Trigger Type] is set to [ON Sampling] and [Sampling] is set to 1 second)

The object script is executed at timing 1.
The object script is executed at timing 2.
At timing 3, the object script is not executed because the timing does not match the end of one cycle and thus the condition 
is not checked.
At timing 4, the object script is not executed because the device condition is not satisfied.
The object script is executed at timing 5.

(b) Using a device condition to trigger the sampling cycle count when the device condition is satisfied
The sampling cycle set for [Trigger Type] does not depend on the device status. (The sampling cycle does not change 
whether the device is turned on or off.)
To start the cyclic sampling, follow the instructions described below.

• Set [Rise] or [Fall] for [Trigger Type].
• Create a sequence program that turns the device on or off when the object script should be executed.

(2) Execution timing when [Sampling], [ON Sampling], or [OFF Sampling] is set
The sampling cycle count starts and is reset at the following timing.
• When the object itself is displayed (in screen switching, a security level change, or other possible cases)
• When the language switches
• When the station No. switches
• When the security level changes
After the execution of any of the events above, the object script is executed at the start timing of the sampling cycle.

OFF

Sampling cycle set for [Trigger Type]
1 second 1 second 1 second

Device status set for [Device]

1 2

3

4 5

ON
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9.10.8 Relevant settings

Set the relevant settings other than the specific settings for object scripts as required.
The following shows the functions that are available by the relevant settings.

■1 GOT internal device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying that an object script error has occurred. GS80.b0

Notifying that a BCD error has occurred. GS80.b7

Notifying that a zero division error has occurred. GS80.b8

Notifying that a communication error (including access to an invalid device) has occurred. GS80.b12

Storing the start device number of the devices where the latest error record is stored. The devices range from GS82 to 
GS113. GS81

Storing the object script error records (including script user ID numbers and error codes). GS82 to GS113

Storing the device number of the device where the latest script execution record is stored. The device is in the range of 
GS115 to GS145. GS114

Storing the script user ID numbers of the executed scripts. GS115 to GS145

Storing a number showing the GOT data registers (GD) where the latest error record is stored. The GD devices are specified 
with GS432 and GS434. GS159

Storing a number showing the GOT data registers (GD) where the latest script execution record is stored. The GD devices 
are specified with GS436 and GS438. GS160

Notifying occurrence of an error which occurs while the integer←→real number conversion is processed. GS260.b14

Notifying the completion of the integer←→real number conversion. GS260.b15

Storing the error code of an error which occurs while the integer←→real number conversion is processed. GS261

Clearing object script error records as shown below.
• GS80.b0, b7, b8, and b12 store 0.
• GS81 stores -1.
• GS82 to GS113 store 0.

GS387.b0

Re-executing the object script aborted due to an error. GS387.b1

Setting the monitoring time for one script. GS388

Controlling whether to run an object script upon screen switching or other applicable processes. The applicable script trigger 
types are as follows.
• [Rise]
• [Fall]
• [Rise/Fall]

GS389

Storing the detailed object script error records.
GS432
GS434
GS435

Storing the detailed object script execution records.
GS436
GS438
GS439

Executing an integer-to-real number conversion.

GS460
GS461
GS462
GS463
GS464
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9.10.9 Troubleshooting

■1 Simulation using a general C language compiler or debugger
Since scripts and C language are similar, you can simulate the scripts by making minor corrections using a general C 
language compiler or debugger.
Complicated scripts including many control statements can be debugged easily by using them.
The following shows the procedure to simulate scripts using a general C language compiler or debugger.

Step 1 Export an object script created with GT Designer3 to a text file or Unicode text file (extension.txt) and change 
it into a C language source file (extension.c).
• Change of the file extension: text1.txt → text1.c

Step 2 Open the C language source file in a commercially-available text editor and create a frame with "main(){}".
Describe "#include<stdio.h>" at the beginning.
• Additional description of "main" and "include"

Step 3 Change the description method of devices (variables, properties) from the one for scripts to the one for C 
language.
Using the following definitions to change the variables into the one for C language enables you to smoothly 
restore them into the GOT scripts.
Definition 1 [w: → _w
Definition 2 [b: → _b
Definition 3 ] → __
Definition 4 my. → my_
Definition 5 $W → device_write
Definition 6 $V → device_value
Definition 7 $$ → monitor_device
Definition 8 $K → key_input
Definition 9 [ → _
Using the batch replacement function of a commercially-available text editor may be useful for the change as 
well.
• Change of the description method of devices (variables)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

#include<stdio.h>
main(){
  [w:TMP0001]=0;
  while([w:TMP0000]<[w:D100]){
       if(!(([w:TMP0000]-1900)%4)){
         [w:TMP0001]=[w:TMP0001]+1;
         my.x = 200;
         my.scale_max[0] = 500; 
         ••• ( Omitted) ••• 
  [w:TMP0010]=[w:TMP0002]+[w:TMP0003]+[w:TMP0004]-1;
  $W = [w:TMP0010]%7;
}

Additional description→ 
Additional description→ 

Additional description→

#include<stdio.h>
main(){
  _wTMP0001__=0;
  while(_wTMP0000__<_wD100__){
        if(!((_wTMP0000__-1900)%4)){
        _wTMP0001__=_wTMP0001__+1;
        my_x = 200;
        my_scale_max_0__ = 500; 
        ••• ( Omitted) ••• 
  _wTMP0010__=_wTMP0002__+_wTMP0003__+_wTMP0004__-1;
  device_write = _wTMP0010__%7;
}

Description change→ 
Description change→ 
Description change→ 
Description change→ 
Description change→ 
Description change→ 

Description change→ 
Description change→
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Step 4 For C language, variables to be used must be defined in advance.
Since only one data type can be set for one script, the same variable type of C language must be set for all the 
variables.
The following shows the data type of scripts.
If [BCD32], [BCD16], or [BCD64] is selected as the script data type, you cannot perform a simulation using the 
general C language compiler or debugger.

Use an appropriate property according to the property range.
Assign an internal variable whose variable type is the same as the data type of the script.
• Variable definition (auto variable declaration)

Step 5 Perform a simulation with the general C language compiler or debugger.
The step run, variable watch, and other functions specific to the debugger can be used.

Data type of scripts Variable type

Signed BIN 16 short

Unsigned BIN 16 unsigned short

Signed BIN 32 long

Unsigned BIN 32 unsigned long

Signed BIN64 long long

Unsigned BIN64 unsigned long long

BCD16

-BCD32

BCD64

Real(32bit) float

Real(64bit) double

#include<stdio.h>
void main(void){
  unsigned short _wTMP0000__;
  unsigned short _wTMP0001__;
  unsigned short _wTMP0002__;
  unsigned short _wD100__;
  short my_c;
  unsigned sort my_scale_max_0__;
  unsigned sort device_write; 
     ••• ( Omitted) ••• 
  _wTMP0001__=0;
  while(_wTMP0000__<_wD100__){
         if(!((_wTMP0000__-1900)%4)){
           _wTMP0001__=_wTMP0001__+1;
           my_x = 200;
           my_scale_max_0__ = 500; 
     ••• ( Omitted) ••• 
  _wTMP0010__=_wTMP0002__+_wTMP0003__+_wTMP0004__-1;
  device_write = _wTMP0010__%7;
}

Description change→ 
Addition  → 
Addition  → 
Addition  → 
Addition  → 
Addition  → 
Addition  → 
Addition  →
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■2 Messages to be displayed at the syntax check
(1) Dialog to be displayed at the syntax check

When you execute a syntax check, the [Script Check] dialog appears to display the error codes of the errors detected in 
a script.
For the details of the error codes, refer to the following.

➟9.9.14 ■2 (2) List of syntax error codes

Some errors cannot be detected by the syntax check.
If any error which cannot be detected by the syntax check exists in the script, the error is detected when the script is 
executed on the GOT.
For the errors for the execution of a script and the corrective action on the GOT, refer to the following.

➟■3 Object script execution errors and their corrective actions on the GOT

■3 Object script execution errors and their corrective actions on the GOT
The following shows how to check the errors and their error codes on the GOT.

To check device values, use the device monitor function or objects (including a numerical display and lamp).

Error code

Item Description

Checking for the occurrence of an error

Check for the occurrence of the following errors.
• Script error
• BCD error
• Zero division error
• Communication error (including access to an invalid device)

➟(1) Checking for the occurrence of an object script error

Checking an error record

Check the following information of an error.
• Script user ID number
• Error code

➟(2) Checking an object script error record

Checking a detailed error record

Check the following information of an error.
• Error code
• Script type
• Screen number
• Object ID number
• Screen type
• Number of the displayed base screen

➟(3) Checking a detailed object script error record

Clearing error records

Turn on GS387.b0 to clear object script error records as shown below.
• GS80.b0, b7, b8, and b12 store 0.
• GS81 stores -1.
• GS82 to GS113 store 0.

Re-executing the object script aborted due to 
an error Turn on GS387.b1 to re-execute the object script aborted due to an error.
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(1) Checking for the occurrence of an object script error
The following GOT internal devices notify the occurrence of errors.

To reset each bit of GS80, turn on GS387.b0.

(2) Checking an object script error record
When an error occurs, the error record is stored into the devices ranging from GS82 to GS113.
GS81 stores the start device number of the devices where the latest error record is stored.
To clear error records, turn on GS387.b0.
The following shows the operation of the relevant GOT internal devices.

GOT internal device Description

GS80

b0 Turns on when a script error occurs.

b7 Turns on when a BCD error occurs.

b8 Turns on when a zero division error occurs.

b12 Turns on when a communication error (including access to an invalid device) occurs.

GOT internal device Description

GS81

Stores the start device number of the devices where the latest error record is stored. The devices range 
from GS82 to GS113.
The value of GS81 changes as follows each time an error occurs.
-1 → 82 → 84 → 86 → 88 → ... → 112 (The next loop will start from 82.)
Example) Relationship between the value of GS81 and the storage location of the latest error record
• When GS81 stores 82, the latest error information is stored in GS82 and GS83.
• When GS81 stores 112, the latest error information is stored in GS112 and GS113.
Turning on GS387.b0 resets GS81 to -1.

GS82 to GS113

Stores the following information when a script error occurs.
• Script number
• Error code
Two word devices are used for one error.

If the number of errors is 17 or more, the error records are overwritten starting from the oldest one.

GS82 Script user ID number

GS83 Error code

GS84 Script user ID number

GS85 Error code

GS112 Script user ID number

GS113 Error code

1st error record

2nd error record

15th error record
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(3) Checking a detailed object script error record
The specified GOT data registers (GD) store error records.
These GD devices are specified with the following GOT special registers (GS).

• GS432: Specify the start device number of the GD devices to store error records.
• GS434: Specify the maximum number of error records.

Example) When GS432 stores 1000, and GS434 stores 5

Eight word devices are used for one error.
For the details of an error record, refer to the following.

➟(4) Details of an object script error record
To start storing error records, turn on GS435.b0.
You can identify the devices storing the latest error record based on the values of GS432 and GS159.
The following shows the operation of the relevant GOT internal devices.

• Write device

• Read device

GOT internal device Description

GS159

Stores a number showing the devices where the latest error record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest error record by using the 
following expression.
• GS432 + (GS159 × 8)
Example) When GS432 stores 1000, and GS159 stores 5
1000 + (5 × 8) = 1040
In this case, GD1040 to GD1047 (eight GD devices) store the latest error record.

GOT internal device Description

GS432
Specify the start device number of the GD devices to store error records.
Data type: Unsigned binary

GS434

Specify the maximum number of error records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no error record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS435.b1 specifies the operation to be performed when the number of errors has 
exceeded the maximum number of error records.

GS435

b0
When this bit is turned on, storing error records starts.
When this bit is turned off, storing error records ends.

b1

Specifies the operation to be performed when the number of errors has exceeded the 
maximum number of error records specified with GS434.
When this bit is turned on, storing error records stops.
When this bit is turned off, storing error records continues by overwriting the oldest record.

b11 When this bit is turned on, the records of warnings (that do not abort a script) are not 
stored.

GD1000 to GD1007
GD1008 to GD1015
GD1016 to GD1023
GD1024 to GD1031
GD1032 to GD1039

1st error record
2nd error record
3rd error record
4th error record
5th error record
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(4) Details of an object script error record
The following shows an example of how an error record is stored in eight word devices starting from GD1000.

(5) List of object script execution error codes

Storage device Item Description

GD1000 Error code
Error code of an error.
For the error details and corrective actions, refer to the following.

➟(5) List of object script execution error codes

GD1001 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 10: Display object script
• 11: Input object script

GD1002 Screen number Number of the screen where the object is placed.

GD1003 Object ID number
ID number of the object where a script error has occurred.
• For project scripts and screen scripts: script number
• For script parts: object ID number

GD1004 Use prohibited The device stores 0.

GD1005 Screen type

Type of the screen where the object is placed.
The device stores any of the following values according to the screen type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
• 400: User-created key window
• 500: Dialog window substituted for a system message
If the script is set for a called screen, the device stores a value by adding a 
number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332

GD1006 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1007 Use prohibited The device stores 0.

Error code Error 
category*1 Description Corrective action

1002 Fatal error
Initialization of objects related to the 
object scripts failed when a screen is 
switched.

• Reduce the number of monitor devices in object scripts and base screens.
• Reduce the number of object scripts presently executed.

1006 Fatal error An error occurred in reading data from the 
device that always collects the data.

Correct the description of the device whose data is out of the specified 
device range.

1011 Execution 
error Writing to a device failed. Check the description of the script.

1014 Fatal error The expression is too complicated to 
process.

Simplify the script operation expression by dividing it or by using other 
appropriate methods.

1015 Fatal error
The object script does not end although 
the object script monitoring time has 
elapsed.

• Check whether the script has gone into an endless loop.
• Increase the value of the Object Script Monitoring Time (GS388).

1016 Fatal error The access to a GOT internal device 
failed.

• Check the operation to a GOT internal device, the script, and sequence 
program.

• Check the description of the script.

1017 Fatal error
The script where an error is detected by 
the syntax check of GT Designer3 was 
executed.

Correct the script where an error is detected by the syntax check of GT 
Designer3.

1018 Fatal error
The access failed since a temporary 
device area outside the range has been 
specified.

Specify the temporary device area within the range.

1019 Fatal error A 8-bit or 64-bit device is specified for an 
indirect device. Correct the description of the indirect device in the relevant script.
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*1 For the details of the error categories, refer to the following.

➟(6) Error category of object scripts and operation at error occurrence

1020 Fatal error Writing to multiple devices was attempted 
in a single script. Correct the number of write devices to the available number.

1021 Fatal error An invalid device type was detected. Correct the device to the one that can be used by the script.

1022 Fatal error Temporary device areas for 32-bit data 
are used for the script of 64-bit data. Correct the common setting of the relevant script.

1031 Fatal error Reference of the internal variable was 
impossible.

Correct the internal valuable according to the object, object script, trigger 
type that allow referring to the internal variable.

1032 Fatal error Assignment to the internal variable was 
impossible.

Correct the internal valuable according to the object, object script, trigger 
type that allow assigning to the internal variable.

1039 Fatal error
The script where an error is detected by 
the syntax check of GT Designer3 was 
executed.

Correct the script where an error is detected by the syntax check of GT 
Designer3.

1045 Fatal error Setting that is not in the object was 
referred to or changed. Refer to or change the property that can be set by the object itself.

1057
Fatal error

The script where an error is detected by 
the syntax check of GT Designer3 was 
executed.

Correct the script where an error is detected by the syntax check of GT 
Designer3.1060

1070 Fatal error An error occurs in the trigger device 
setting. Check the trigger device setting.

1108 Execution 
error

The operation result cannot be handled in 
BCD data.

• Check the setting of the monitored device.
• Check the operation of device which could not process the BCD data.

1109 Execution 
error

The operation result was outside the BCD 
data range. Check the operation of the device whose BCD data is outside the range.

1110 Execution 
error Zero division was executed. Check the zero division of the script.

1111 Execution 
error A 64-bit operation overflow has occurred. Check the description of the relevant script and correct it.

1131 Execution 
error

Reference of the internal variable was 
impossible. Cheek the internal variable to be referred to.

1141 Execution 
error

A value outside the property range was 
set. Check the assigned value of the property.

1142 Execution 
error

For the element number of the property 
that specifies an array, a value outside the 
range was set.

Check the element number of the property that specifies an array.

1143 Execution 
error

• The object font was not the standard 
font.

• For object fonts other than 16-dot 
standard, 0 (display in 0.5 times) was 
set.

Check the assigned value of the property.

1144 Execution 
error

The magnification value set in the target 
object is larger than the value set in the 
figure.

Check the assigned value of the property.

1246 Warning

The number of decimal places specified 
for a numerical display or numerical input 
object cannot be read or written using an 
object property in the script.

The number of decimal places specified with a device cannot be read or 
written using an object property in the script.
Correct the relevant setting.

1251 Warning Either of the coordinate or radius is 
incorrect. Check the argument in the drawing execution function.

1252 Warning Any of the line type, line width, or line 
color is incorrect. Check the argument in the drawing execution function.

1253 Warning Any of the pattern, shape color, or 
background color is incorrect. Check the argument in the drawing execution function.

1254 Warning

Any of the character attribute, character 
color, character shade color, character 
scale ratio, character string code, or 
character string length is incorrect.

Check the argument in the drawing execution function.

1255 Warning No comment is assigned to the comment 
No. of the specified comment group No. Check the argument in the drawing execution function.

1256 Warning The stored amount of drawing data 
exceeded the allowable capacity. Reduce the number of functions.

Error code Error 
category*1 Description Corrective action
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(6) Error category of object scripts and operation at error occurrence
(a) Error category

The following shows the categories of the object script error codes. When an error occurs, the object script operates as 
follows.

*1 The operation of the object with the object script where the error has occurred varies according to the set operating condition.

(b) Script which has been executed before an error occurs
Reflection of the written value and execution of a function differ depending on the target device to be written and function 
to be executed.
Writing to a device:
If writing to a device is executed by the script which has been executed before an error occurs, the written value is reflected 
as follows.

○: Written value is reflected. ×: Written value is not reflected.

Executing a function:
If a function is executed by the script which has been executed before an error occurs, the function is executed as follows.

○: Function is executed. ×: Function is not executed.

Error category Object script operations at error occurrence

Fatal error
The object script stops.
Even if the trigger condition is satisfied again, the object script does not operate.
For the object script where the error has occurred, drawing the object and writing to a device stop.*1

Execution error

The object script stops.
If the trigger condition is satisfied again, the object script operates.
For the object script where the error has occurred, drawing the object and writing to a device stop.*1If this error occurs 
repeatedly, the subsequent errors are not written into GS82 to GS113.

Warning The object script does not stop.

Operating condition of object script Monitor function of object Write function of object

Key code input
Input fixation
Device writing

Operates Stops

View Change
Synchronize Display Trigger
Ordinary

Stops Operates

Other than above Stops Stops

Target device to be written Operation at error occurrence

GOT internal device (GB and GD) ○

GOT internal device (Other than GB and GD) ×

Controller device ×

Temporary device area ○

Target function to be written or executed Operation at error occurrence

Free figure drawing ×

Object update function ○

Object display clear function ○

Screen update function ○

Internal variable ×

Property ○
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■4 How to check an object script execution record
The following shows how to check a script execution record on the GOT.

To check device values, use the device monitor function or objects (including a numerical display and lamp).

(1) Checking an object script execution record
When a script runs, the script user ID number is stored into the device in the range of GS115 to GS145.
GS114 stores the device number of the device where the latest script execution record is stored.
The following shows the operation of the relevant GOT internal devices.

(2) Checking a detailed object script execution record
The specified GOT data registers (GD) store script execution records.
These GD devices are specified with the following GOT special registers (GS).

• GS436: Specify the start device number of the GD devices to store script execution records.
• GS438: Specify the maximum number of script execution records.

Example) When GS436 stores 1000, and GS438 stores 5

Eight word devices are used for one script execution record.
For the details of a script execution record, refer to the following.

➟(3) Details of an object script execution record
To start storing script execution records, turn on GS439.b0.
You can identify the devices storing the latest script execution record based on the values of GS436 and GS160.
The following shows the operation of the relevant GOT internal devices.

• Write device

Item Description

Checking a script execution record
Check the script user ID number of an executed script.

➟(1) Checking an object script execution record

Checking a detailed script execution record

Check the following information on an executed script.
• Script type
• Screen number
• Object ID number
• Screen type
• Number of the displayed base screen

➟(2) Checking a detailed object script execution record

GOT internal device Description

GS114

Stores the device number of the device where the latest script execution record is stored. The device is in the 
range of GS115 to GS145.
The value of GS114 changes as follows each time a script runs.
-1 → 115 → 116 → 117 → 118 → ... → 145 (The next loop will start from 115.)

GS115 to GS145

Store the script user ID numbers of the executed scripts.
One word device is used for one script.
If the number of the executed scripts is 32 or more, the script execution records are overwritten starting from 
the oldest one.

GOT internal device Description

GS160

Stores a number showing the devices where the latest script execution record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest script execution record by using 
the following expression.
• GS436 + (GS160 × 8)
Example) When GS436 stores 1000, and GS160 stores 5
1000 + (5 × 8) = 1040
In this case, GD1040 to GD1047 (eight GD devices) store the latest script execution record.

GD1000 to GD1007
GD1008 to GD1015
GD1016 to GD1023
GD1024 to GD1031
GD1032 to GD1039

1st script execution record
2nd script execution record
3rd script execution record
4th script execution record
5th script execution record
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• Read device

(3) Details of an object script execution record
The following shows an example of how a script execution record is stored in eight word devices starting from GD1000.

GOT internal device Description

GS436
Specify the start device number of the GD devices to store script execution records.
Data type: Unsigned binary

GS438

Specify the maximum number of script execution records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no script execution record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS439.b1 specifies the operation to be performed when the number of the executed scripts has 
exceeded the maximum number of script execution records.

GS439

b0
When this bit is turned on, storing script execution records starts.
When this bit is turned off, storing script execution records ends.

b1

Specifies the operation to be performed when the number of the executed scripts has exceeded the 
maximum number of script execution records specified with GS438.
When this bit is turned on, storing script execution records stops.
When this bit is turned off, storing script execution records continues by overwriting the oldest 
record.

Storage device Item Description

GD1000 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 10: Display object script or switch object script
• 11: Input object script

GD1001 Screen number Number of the screen where the object is placed.

GD1002 Object ID number ID number of the object where a script runs.

GD1003 Use prohibited The device stores 0.

GD1004 Screen type

Type of the screen where the object is placed.
The device stores any of the following values according to the screen type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
• 400: User-created key window
• 500: Dialog window substituted for a system message
If the script is set for a called screen, the device stores a value by adding a 
number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332
The device stores 0 for a project script.

GD1005 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1006 Use prohibited The device stores 0.

GD1007 Use prohibited The device stores 0.
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10.1 Using a Barcode Reader with the GOT (Barcode Function)

Not available to GT25HS-V.

10.1.1 Overview of the barcode function

Not available to GT25HS-V.
The barcode function enables the GOT to read the data from a barcode by using a barcode reader.
The read data is processed as follows.

■1 Writing read data into controllers

■2 Directly inputting read data to objects (numerical input and text input)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

123456789

Barcode

GOT

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

36h

6

37h

7

38h

8

39h

9

Read data Terminator

D0 (00h)
2

(32h)
1

(31h)
4

(34h)
3

(33h)
6

(36h)
5

(35h)
8

(38h)
7

(37h)
SP

(20h)
9

(39h)

(09h)

D1

D2

D3

D4

D5

9

Read data
123456789

Stored data

Read bytes

QCPU (Q mode)

123456789

Barcode

GOT

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

36h

6

37h

7

38h

8

39h

9

Read data Terminator

QCPU (Q mode)

Data is input in the touched object.

123456789
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10.1.2 Specifications of the barcode function

Not available to GT25HS-V.

■1 System application (extended function)
(1) Serial barcode reader

To use the barcode function, a system application (extended function) of [Bar Code (Serial)] is required.
Select [Use Serial Bar Code] in the [Bar Code] dialog ([Serial] tab) to incorporate the application into the package data 
automatically.

➟10.1.5 [Bar Code] dialog
To use the function on GT21, GT SoftGOT2000, or GS21, the application is not required.

(2) USB barcode reader
Only available to GT2107-W of GT21 models.
Not available to GT SoftGOT2000 and GS21.
To use the barcode function, a system application (extended function) of [Bar Code (USB)] is required.
Select [Use USB Bar Code] in the [Bar Code] dialog ([USB] tab) to incorporate the application into the package data 
automatically.

➟10.1.5 [Bar Code] dialog
To use the function on GT21, the application is not required.

■2 Applicable barcode readers
One serial barcode reader and one USB barcode reader are usable simultaneously.

(1) Serial barcode reader
You can use the serial barcode readers that satisfy the header and terminator specifications referred to in the following.

➟10.1.7 ■2 Header and terminator
For the validated serial barcode readers, refer to Technical News GOT-A-0160 "List of Valid Devices Applicable for 
GOT2000 Series and GOT SIMPLE Series (for Overseas)" separately available.

(2) USB barcode reader
Only available to GT2107-W of GT21 models.
Not available to GT SoftGOT2000.
You can use the USB barcode readers that satisfy the following conditions.

• A USB keyboard interface is provided.
• The Japanese 106 keyboard or the English 101 keyboard is settable as the USB keyboard type.
• "Enter" is settable as the terminator.

When data is input from a USB barcode reader, the GOT supports only the ASCII code characters that can be output 
using a USB keyboard.
The GOT ignores data that is input in any characters other than the ASCII code characters.
Katakana, Hiragana, and Kanji characters contained in a QR code cannot be read with USB barcode readers.
These characters are readable with serial barcode readers.
For the validated USB barcode readers, refer to Technical News GOT-A-0160 "List of Valid Devices Applicable for 
GOT2000 Series and GOT SIMPLE Series (for Overseas)" separately available.

■3 Number of barcode function settings for one project
One barcode function setting is available for one project.

■4 Devices for storing data read by the barcode reader and device points
(1) Devices that can store the data

The data can be stored in the word device.
The bit device cannot be specified as the word device.

(2) Maximum number of devices
Up to 2000 device points can be set.
One read byte and up to 1999 read data are stored in the device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.1.3 Basic use of the barcode function

Not available to GT25HS-V.

■1 System configuration
GT SoftGOT2000 does not support USB barcode readers.
The following shows the system configuration of the barcode reader.
When you use the barcode reader on GT SoftGOT2000, the barcode reader is connected to the personal computer.
Therefore, the barcode reader requires no connection to the GOT hardware.
For the connection method with GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

*1 Only GT2107-W supports USB barcode readers.
*2 GS21 does not support USB barcode readers.

■2 Setting procedure
(1) Serial barcode reader

Step 1 Connect a serial barcode reader to the GOT.

➟■1 System configuration
Step 2 In the [Bar Code] dialog ([Serial] tab), configure the barcode function setting.

➟10.1.5 [Bar Code] dialog
Step 3 Set the system signal according to the channel number used.

➟10.1.6 System information settings
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Check proper operation of the barcode function.

➟10.1.7 Action of the barcode function

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Barcode reader Connection cable GOT PLC Number of connectable 
barcode readers

For the connectable barcode readers and 
system devices, the type of the barcode that 
can be read, and the connection cables, refer 
to the following Technical News.

➟List of Valid Devices Applicable for 
GOT2000 Series and GOT SIMPLE Series 
(for Overseas) (GOT-A-0160)

Depending on the 
specifications of the 
barcode reader

GT27
GT25
GT23

GT21 *1

GS25

GS21 *2

For the system configuration 
between the GOT and the 
PLC, refer to each connection 
manual.

One serial barcode reader 
and one USB barcode 
reader for one GOT

GOTBarcode reader PLC

The system configuration between GOT and 
PLC depends on the connection type.

Connection cable
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(2) USB barcode reader
Only available to GT2107-W of GT21 models.
Not available to GT SoftGOT2000 and GS21.

Step 1 Connect a USB barcode reader to the GOT.

➟■1 System configuration
Step 2 In the [GOT Setup] window ([USB Host]), select [Use USB keyboard/USB bar code] and set [Keyboard Type] 

according to the setting of the USB barcode reader used.

➟5.3.4 ■4 [USB Host]
Step 3 In the [Bar Code] dialog ([USB] tab), configure the barcode function setting.

➟10.1.5 [Bar Code] dialog
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Check proper operation of the barcode function.

➟10.1.7 Action of the barcode function

10.1.4 Advanced use of the barcode function

Not available to GT25HS-V.

■1 Directly inputting the data to the object (numerical input or text input)
To directly input the data to the object (numerical input or text input), the setting for using the barcode function is required 
for the object.
When the object (numerical input or text input) is not in the ready state for the data read by the barcode reader to be directly 
input, the read data is cleared.
To input the data, touch the object (numerical input or text input) input, and read the data with the cursor displayed.

■2 Input completion notification settings
This setting is required for using a serial barcode reader.

(1) When the input completion notification is disabled
Establishing a handshake is not required by using the External Device I/O signal and the External Device I/O Complete 
signal.
If the data is sequentially read into the object, old data is immediately overwritten by new data in each time.

(2) When the input completion notification is enabled
The data cannot be input to the object until the External Device I/O signal is turned off by the External Device I/O 
Complete signal.
For the action of the System signal, refer to the following.

➟10.1.7 (1) Control devices

■3 Switching the behavior of the USB barcode reader
Only available to GT2107-W of GT21 models.
Not available to GT SoftGOT2000 and GS21.
The Switch USB Barcode Input signal is usable to switch between the USB keyboard function and the barcode function.
For setting the Switch USB Barcode Input signal, refer to the following.

➟10.1.5 ■2 [USB] tab
• When the Switch USB Barcode Input signal is on

The USB barcode reader performs the USB keyboard function.
For the details of the USB keyboard function, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])
• When the Switch USB Barcode Input signal is off

The USB barcode reader performs the barcode function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.1.5 [Bar Code] dialog

Not available to GT25HS-V.
Select [Common] → [Peripheral Setting] → [Bar Code] from the menu to display the setting dialog.

➟■1 [Serial] tab
■2 [USB] tab

■1 [Serial] tab

Not available to GT25HS-V.
This setting is required for using a serial barcode reader.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Yes] is selected for 
[Read Data Direct Input to Object].

1)

2)

3)

[No] is selected for [Read Data Direct Input to Object].
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1) [Destination I/F]
Set the interface of the GOT.
The following shows the items to be selected.

• [Standard I/F(RS422/485)] (For GT21-P: [Standard I/F(RS422/485/232(Side))])
• [Standard I/F(RS232)] (For GT21-P: [Standard I/F(RS232(Back))])
• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

[Extend I/F(1st)], [Extend I/F(2nd)], and [Ex-tend I/F(3rd)] are not available for GT25-W, GT2505-V, GT25HS-V, 
GT23, GT21, GT Soft-GOT2000, GS25, and GS21.

Item Description

[Detail Setting] button

Configure the detail setting in the [Detail Setting] window.

• [Transmission Speed(BPS)]
Select the transmission speed.
The following shows the items to be selected.
• [4800]
• [9600]
• [19200]
• [38400]
• [57600]
• [115200]

• [Data Bit]
Select the data length.
The following shows the items to be selected.
• [7bit]
• [8bit]

• [Stop Bit]
Select the stop bit length.
The following shows the items to be selected.
• [1bit]
• [2bit]

• [Parity]
Select the type for a parity check.
The following shows the items to be selected.
• [None]
• [Even]
• [Odd]
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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2) [Use Serial Bar Code]
Enables the barcode function setting.

3) [Input Completion Notification]
Select whether to enable or disable the completion notification of data input processing by the System signal 
(External Device I/O signal and External Device I/O Complete signal).
The setting range is [Disable] or [Enable].

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

Item Description

[Read Data Direct Input to Object]

Select whether to write the data read by a serial barcode reader into controller devices, or 
to input the read data to an object (numerical input or text input).
• [No]: Writes the data into the controller.
• [Yes]: Directly inputs the data to the numerical input or text input.
To directly input the data to the object (numerical input or text input), the setting for using 
the barcode reader is required for the object.
➟8.4.5 [Numerical Input] dialog
8.5.5 [Text Input] dialog

[Device] Set the start device of consecutive devices that store the data read by a serial barcode 
reader.

[Device Points]
Set the number of devices that store the data read by the barcode reader.
The setting range is [2] to [2000].

[Header]

Select a header for the barcode read by a serial barcode reader.
The following shows the items to be selected.
• [None]
• [STX]
• [ENQ]
• [User-specified]: Up to four bytes are settable.

Specify a value for a byte in the range of 0x00 to 0xFF.
When you select [User-specified], refer to the following.

➟(1) [Setting] dialog (for setting the header or terminator)

[Terminator]

Select a terminator for the barcode read by a serial barcode reader.
The following shows the items to be selected.
• [ETX]
• [LF]
• [CR]
• [CR+LF]
• [User-specified]: Up to four bytes are settable.

Specify a value for a byte in the range of 0x00 to 0xFF.
When you select [User-specified], refer to the following.
➟(1) [Setting] dialog (for setting the header or terminator)

[Data Writing Order]

Select the order of writing the data into the controller device.
• [Low --> High]: The data is written into the controller device in the order of lower 8 bits to 

upper 8 bits.
• [High --> Low]: The data is written into the controller device in the order of upper 8 bits to 

lower 8 bits.

[Fill up a space when imported data is less 
than the writing points]

Select this item to fill blank devices with spaces or NULLs when the number of bytes of the 
data read by the barcode reader is less than the set device points.
• [Space]: Fills the blank device with spaces (20H).
• [NULL]: Fills the blank device with NULLs (00H).
10 - 8 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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(1) [Setting] dialog (for setting the header or terminator)

1) Header/terminator entry field
Enter values for the header or terminator.
A cell where an entry is made is counted as a valid byte.

2) [Enter by character codes]
Enter values in hexadecimal.

3) ASCII code table
Lists the selectable ASCII codes.
Click a character to enter it into the header/terminator entry field.

1)

3)

2)
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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■2 [USB] tab

Not available to GT25HS-V.
Only available to GT2107-W of GT21 models.
This setting is required for using a USB barcode reader.

1) [Destination I/F]
Displays the GOT interface to be used.
The interface is fixed at [USB Host].

2) [Use USB Bar Code]
Enables the barcode function setting.

Item Description

[Device] Set the start device of consecutive devices that store the data read by a USB barcode 
reader.

[Device Points] Set the number of devices that store the data read by the barcode reader. The setting 
range is [2] to [2000].

[Notification Device]

Set the device that notifies the processing status of the data read by a USB barcode 
reader.

➟6.1 Device Settings
A word device is settable.
For the function of each bit of the device, refer to the following.

➟(1) [Notification Device]

[Control Device]

Set the device that controls the processing of the data read by a USB barcode reader.

➟6.1 Device Settings
A word device is settable.
For the function of each bit of the device, refer to the following.

➟(2) [Control Device]

[Data Writing Order]

Select the order of writing the data into the controller device.
• [Low --> High]: The data is written into the controller device in the order of lower 8 bits to 

upper 8 bits.
• [High --> Low]: The data is written into the controller device in the order of upper 8 bits to 

lower 8 bits.

[Fill up a space when imported data is less 
than the writing points]

Select this item to fill blank devices with spaces or NULLs when the number of bytes of the 
data read by the barcode reader is less than the set device points.
• [Space]: Fills the blank device with spaces (20H).
• [NULL]: Fills the blank device with NULLs (00H).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
10 - 10 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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(1) [Notification Device]
The following shows the function of each bit of the set device.

(2) [Control Device]
The following shows the function of each bit of the set device.

Bit number Signal name Function

b0 to b5 Use prohibited -

b6 USB Barcode Input signal
Turns on when the data read by a USB barcode reader is stored to specified devices.
Turns off when the USB Barcode Read Completed signal (b6 of the control device) 
turns on.

b7 to b15 Use prohibited -

Bit number Signal name Function

b0 Switch USB Barcode Input signal

Switches the behavior of the USB barcode reader
This signal is disabled when the Enable Operator Authentication signal (Control 
device.b1) is turned on and the GOT displays the screen for login with an external 
authentication device.
• ON

The USB barcode reader performs the USB keyboard function.
For the details of the USB keyboard function, refer to the following.
➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT 

([USB Host])
• OFF

The USB barcode reader performs the barcode function.

b1 Enable Operator Authentication signal

Turn on this signal and display the screen for login with an external authentication 
device on the GOT to enable the operator authentication with a USB device.
For the details of the operator authentication, refer to the following.

➟5.2.7 Configuring the security settings for the GOT screen ([Screen Security] 
(Operator authentication))

b2 Enable USB Device Input During 
Operator Authentication signal

Turn on this signal to enable the operator authentication data read by a USB device to 
be saved into devices.
For the details of the operator authentication, refer to the following.

➟5.2.7 Configuring the security settings for the GOT screen ([Screen Security] 
(Operator authentication))

b3 to b4 Use prohibited -

b5 Disable USB Barcode Input signal Turn on this signal to disable the barcode function.

b6 USB Barcode Read Completed signal

Turn on this signal for the GOT to recognize that the stored barcode data has been 
transferred from the specified devices to different devices.
Turn on this signal to turn off the USB Barcode Input signal (b6 of the notification 
device).

b7 to b15 Use prohibited -
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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10.1.6 System information settings

Not available to GT25HS-V.
This setting is required for using a serial barcode reader.
If you use a USB barcode reader, set [Notification Device] and [Control Device] in the [Bar Code] dialog ([USB] tab).

➟10.1.5 ■2 [USB] tab

■1 Setting the system information
Make sure to set one of the following System signals according to the channel No. you use.
For GT SoftGOT2000, set the System signal used for channel No.5 of the GOT.
The barcode function is not available without the setting.

For the details of the system information, refer to the following.
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■2 Action of the barcode function according to the System signal status
While the following System signals are on, the data read by the barcode reader is not written into the controller.
Use a sequence program or other methods to turn off the External Device I/O signal and the External Device I/O Complete 
signal.

(1) System signal 1-1

(2) System signal 2-1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Channel No. System signal

Channel No.8 System signal 1-1, System signal 2-1

Channel No.5
System signal 1-2, System signal 2-3
(Not available to GT21 and GS21)

Channel No.6

Channel No.7

Barcode Input Disable signal
External Device I/ O Complete signal (CH8)

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

External Device I/O signal (CH8)

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0
10 - 12 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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10.1.7 Action of the barcode function

Not available to GT25HS-V.

■1 Order of writing data into the controller
Set the order of writing the data read by the barcode reader into the controller.

(1) Low → High
The data is written into the controller device in the order of lower 8 bits to upper 8 bits.

(2) High → Low
The data is written into the controller device in the order of upper 8 bits to lower 8 bits.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

12345

Barcode

GOT

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

Read data Terminator

D0 (00h)
2

(32h)
1

(31h)
4

(34h)
3

(33h)

(20h)
5

(35h)

(05h)

D1

D2

D3

5

Read data
12345

Stored data

Read bytes

(Header: None, Terminator: CR)

Data is stored in order of lower 8 bits to upper 8 bits.

12345

Barcode

GOT

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

Read data Terminator

(Header: None, Terminator: CR)

D0 (00h)
1

(31h)
2

(32h)
3

(33h)
4

(34h)

(35h)
5

(20h)

(05h)

D1

D2

D3

5

Read data
12345

Stored data

Read bytes

Data is stored in order of upper 8 bits to lower 8 bits.
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.1 Using a Barcode Reader with the GOT (Barcode Function)

10 - 13



■2 Header and terminator
If you use a serial barcode reader, set the header and terminator for the read barcode.

Item Description

Header

None 
(Default)

The read data is as follows when the header is not added to the head of data.

STX

The read data and STX are set as follows when STX is added to the head of data.

ENQ

The read data and ENQ are set as follows when ENQ is added to the head of data.

User-
specified

The user-specified values are prepended to the read data.
Example) When 41h, 42h, 43h, and 44h are specified

Terminator

ETX

The read data and ETX are set as follows when ETX is added to the end of data.

LF

The read data and LF are set as follows when LF is added to the end of data.

CR (Default)

The read data and CR are set as follows when CR is added to the end of data.

CR+LF

The read data and CR+LF are set as follows when CR+LF is added to the end of data.

User-
specified

The user-specified values are appended to the read data.
Example) When 61h, 62h, and 63h are specified

31h 32h 33h 34h 35h

1 2 3 4 5

Read data

31h 32h 33h 34h 35h

1

02h

STX 2 3 4 5

Read dataHeader

31h 32h 33h 34h 35h

1

05h

ENQ 2 3 4 5

Read dataHeader

Read dataHeader

A B C D

41h 42h 43h 44h

1 2 3 4 5

31h 32h 33h 34h 35h

31h 32h 33h 34h 35h

1

03h

ETX2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Ah

LF2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Dh

CR

0Ah

LF2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1 2 3 4 5

61h 62h 63h

a b c

Read data Terminator
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■3 Data to be stored in devices
The data read by the barcode reader is written into the controller device as the string data.
Example)
• Read data: 123456789
• Order of writing data: Low → High

(1) When the number of read data is less than the set device points
Settings (Storage device: D0, Data points: 8)

(2) When the number of read data is more than the set device points
Settings (Storage device: D0, Data points: 4)

D0 -0009h

: Space

D1

D2

D3

D4

D5

D6

D7

21

43

65

87

3231h

3433h

3635h

3837h

2039h

2020h

2020h

  9

The GOT writes the bytes of the read data.

The GOT writes the read data in the order from lower byte.

When the number of bytes of the data read by the barcode 
reader is less than the set device points, fill blank devices 
with spaces (20h) or NULLs (00h).

Write device Stored data String data

The GOT writes the bytes of the read data.

The GOT writes the read data in the order from lower byte.

The data that exceeds the set device points is not written.

D0 -0009h

D1

D2

D3

21

43

65

3231h

3433h

3635h

Write device Stored data String data
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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■4 Operation example of the barcode function (Serial barcode reader)
The following shows the action timing of the barcode function.
Example) GT Designer3 settings

• The barcode reader is connected to the GOT by using channel No.8.
• [No] is selected for [Read Data Direct Input to Object].
• System signal 1-1: D11 
• System signal 2-1: D12
• Device: D1000
• Data points: 8

(1) Control devices

(2) Handshake

Step 1 The GOT receives data from a serial barcode reader.
Step 2 When the Barcode Input Disable signal is off, the process proceeds to the next step.
Step 3 The received data is stored to specified devices.
Step 4 The External Device I/O signal (CH8) turns on upon storage of the data.
Step 5 A user-created program transfers the stored data from the specified devices to different devices.
Step 6 The user-created program turns on the External Device I/O Complete signal (CH8).
Step 7 The External Device I/O signal (CH8) turns off upon turn-on of the External Device I/O Complete signal 

(CH8).
Step 8 The user-created program turns off the External Device I/O Complete signal (CH8).

(3) Example of the sequence program (When the GOT is connected to QCPU by using channel No.8)
While the External Device I/O Complete signal and the External Device I/O signal are on, the data read by the barcode 
reader is not written into the controller.
Create a sequence program so that the External Device I/O Complete signal and the External Device I/O signal are turned 
off.

Device Item

System information
External Device I/O Complete signal (CH8)(System signal 1-1.b6) External Device I/O signal (CH8)(System signal 2-
1.b6)
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

User-created program

GOT

GOT

Barcode Input Disable 
signal (CH8) 
(System signal 1-1.b5)

External Device I/O 
signal (CH8) 
(System signal 2-1.b6)

External Device I/O Complete 
signal (CH8) 
(System signal 1-1.b6)

Receiving data 
31h,32h,33h

Storing data 
31h,32h,33h

D1000

R1000

1.

2.
3.

4.

5.

6.

7.

8.

D1000

D11.6

K8

D11.6

D11.6D12.6

D12.6

RST

SET

R10000

24

BMOVP

The External Device I/O Complete signal (CH8) turns off.

When the GOT stores the received data in the specified 
device and turns on the External Device I/O signal (CH8), 
the data stored in the specified device is moved to any of 
the other devices. 
After the data is moved, the External Device I/O Complete 
signal (CH8) turns on.
10 - 16 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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■5 Operation example of the barcode function (USB barcode reader)
Only available to GT2107-W of GT21 models.
Not available to GT SoftGOT2000 and GS21.
The following shows the action timing of the barcode function.
Example) GT Designer3 settings

• [Notification Device]: D11
• [Control Device]: D12
• Device: D1000
• Data points: 8

(1) [Notification Device], [Control Device]

(2) Handshake

Step 1 The GOT receives data from a USB barcode reader.
Step 2 When the Switch USB Barcode Input signal and the Disable USB Barcode Input signal are off, the process 

proceeds to the next step.
Step 3 The received data is stored to specified devices.
Step 4 The USB Barcode Input signal turns on upon storage of the data.
Step 5 A user-created program transfers the stored data from the specified devices to different devices.
Step 6 The user-created program turns on the USB Barcode Read Completed signal.
Step 7 The USB Barcode Input signal turns off upon turn-on of the USB Barcode Read Completed signal.
Step 8 The user-created program turns off the USB Barcode Read Completed signal.

While the USB Barcode Input signal or the USB Barcode Read Completed signal is on, the read barcode data is not 
stored to the specified devices.
Create a sequence program so that the USB Barcode Input signal and the USB Barcode Read Completed signal are 
turned off.

Device Item

[Notification Device] • USB Barcode Input signal (b6 of the notification device)

[Control Device]
• Switch USB Barcode Input signal (b0 of the control device)
• Disable USB Barcode Input signal (b5 of the control device)
• USB Barcode Read Completed signal (b6 of the control device)

User-created program

GOT

GOT

Switch USB Barcode Input signal 
(b0 of the control device)
Disable USB Barcode Input signal 
(b5 of the control device)

USB Barcode Input signal 
(b6 of the notification device)

USB Barcode Read Completed signal 
(b6 of the control device)

D1000

R1000

1.
2.

3.

4.

5.

6.

7.

8.

Receiving data 
31h,32h,33h

Storing data 
31h,32h,33h
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10.1.8 Precautions

Not available to GT25HS-V.

■1 Precautions for hardware
When the barcode reader is used with [Standard I/F(RS232)], 5V power supply from the GOT should be enabled on some 
barcode readers.
For the barcode that can be read, refer to Technical News GOT-A-0160 "List of Valid Devices Applicable for GOT2000 
Series and GOT SIMPLE Series (for Overseas)" separately available, or contact your local distributor.

■2 Precautions for using a USB barcode reader
(1) Handshake when a USB barcode reader reads data

When you use a USB barcode reader for writing the read data to specified devices, turn off the USB Barcode Input signal 
and the USB Barcode Read Completed signal before a barcode reading.
If a barcode reading is performed while the signals are on, the read data is deleted.

(2) Outputting a special interrupt code through the microcomputer connection
Even if the special interrupt code output is enabled, the special interrupt code (23H) is not output.
For the special interrupt code output through the microcomputer connection, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

(3) Switching between the ON and OFF states of the Switch USB Barcode Input signal
If you switch between the ON and OFF states of the Switch USB Barcode Input signal while a USB barcode reader is 
reading data, unintended behavior may result.
Do not switch the ON and OFF states of the signal while a USB barcode reader is reading data.

(4) Character code of the input values
The input values read by a USB barcode reader are handled as ASCII characters.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.1.9 Relevant settings

Not available to GT25HS-V.
Set the relevant settings other than the specific settings for the barcode function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT environmental settings (System information)
These settings are unavailable when a USB barcode reader is used.
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

*1 Not available to GT21 and GS21.

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

*1 Not available to GT21 and GS21.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Target CH Function Setting item

CH5*1

Switching the enabled or disabled status of the barcode function. (Read device: System signal 1-2.b2) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b0). (Read device: System 
signal 1-2.b3) [System Signal 1-2]

Notifying that the data read by the barcode reader is stored into the specified device. (Write device: System signal 
2-3.b0) [System Signal 2-3]

CH6*1

Switching the enabled or disabled status of the barcode function. (Read device: System signal 1-2.b5) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b1). (Read device: System 
signal 1-2.b6) [System Signal 1-2]

Notifying that the data read by the barcode reader is stored into the specified device. (Write device: System signal 
2-3.b1) [System Signal 2-3]

CH7*1

Switching the enabled or disabled status of the barcode function. (Read device: System signal 1-2.b8) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b2). (Read device: System 
signal 1-2.b9) [System Signal 1-2]

Notifying that the data read by the barcode reader is stored into the specified device. (Write device: System signal 
2-3.b2) [System Signal 2-3]

CH8

Switching the enabled or disabled status of the barcode function. (Read device: System signal 1-1.b5) [System Signal 1-1]

Turning on this signal turns off the External Device I/O signal (System signal 2-1.b6). (Read device: System 
signal 1-1.b6) [System Signal 1-1]

Notifying that the data read by the barcode reader is stored into the specified device. (Write device: System signal 
2-1.b6) [System Signal 2-1]

Function Setting item

Notifying that the object is in the ready state for the data read by the barcode reader and the RFID to be directly input. (Write 
device)*1 GS243.b15
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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10.2 Using an RFID with the GOT (RFID Function)

Not available to GT25HS-V.

10.2.1 Overview of the RFID function

Not available to GT25HS-V.
The RFID function enables you to send and receive the data by an RFID reader/writer of an RFID controller connected 
to the GOT, and enables you to read the data from the received data.
The read data is processed as follows.

■1 Writing read data into controllers

■2 Directly inputting read data to objects (numerical input and text input)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

IC tag

RFID reader/writer

GOTRFID controller

SP

4

2

5

3

1

5

Requesting to read data

1 2 3 4 5

Receiving data

Data of IC tag

SP

4

2

5

3

1

5

Received data

IC tag

RFID reader/writer

GOTRFID controller

Requesting to read data

1 2 3 4 5

Receiving data

Data of IC tag

SP

4

2

5

3

1

5

12345

Data is input in the touched object.
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10.2.2 Specifications of the RFID function

Not available to GT25HS-V.

■1 System application (extended function)
To use the RFID function, a system application (extended function) of [RFID] is required.
Selecting [Use RFID] in the [RFID] dialog incorporates the application into the package data automatically.

➟10.2.5 [RFID] dialog
To use the function on GT SoftGOT2000, the application is not required.

■2 Applicable RFID controllers
Applicable RFID controllers should meet the specifications of the dedicated protocol and nonprocedural protocol as 
shown below.

Select the dedicated protocol that corresponds to the RFID controller to be used.
When no dedicated protocol corresponds to the RFID controller to be used, select the nonprocedural protocol.
For selecting the protocol, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

The following shows devices used for each protocol and a handshake example.
➟10.2.7 Action of an RFID

For applicable RFID controllers, refer to Technical News GOT-A-0160 "List of Valid Devices Applicable for GOT2000 
Series and GOT SIMPLE Series (for Overseas)" separately available, or contact your local distributor.

■3 Connecting the RFID controller for the operator authentication
To use an RFID controller for the operator authentication, the controller can be connected to only the RS-232 interface built 
in the GOT.

■4 Number of RFID function settings for one project
One RFID function setting is available for one project.

■5 Devices for storing data read by RFID reader/writer and the number of device points
(1) Devices that can store the data

The data can be stored in the word device.
The bit device cannot be specified as the word device.

(2) Maximum number of devices
Up to 10000 devices can be set for the sent data and the received data in total.
For GT21 and GS21, up to 2000 devices can be set for the sent data and the received data, respectively.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Protocol Reference

Dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.) ➟10.2.7 ■6 (1) Dedicated protocol (LSRF manufactured by LS 
Industrial Systems Co., Ltd.)

Dedicated protocol (ICU-60S manufactured by MARS TOHKEN SOLUTION 
CO.LTD.) ➟10.2.7 ■6 (2) Dedicated protocol (ICU-60S or ICU-215 (Mifare) 

manufactured by MARS TOHKEN SOLUTION CO.LTD.)Dedicated protocol (ICU-215 (Mifare) manufactured by MARS TOHKEN 
SOLUTION CO.LTD.)

Nonprocedural protocol ➟10.2.7 ■6 (3) Nonprocedural protocol
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10.2.3 Basic use of the RFID function

Not available to GT25HS-V.

■1 System configuration
The following shows the system configuration of RFID.
When you use the RFID on GT SoftGOT2000, the RFID is connected to the personal computer. Therefore, the RFID 
requires no connection to the GOT hardware.
For the connection method with GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

■2 Setting procedure
Step 1 Connect the GOT and the RFID

➟■1 System configuration
Step 2 Configure the settings for the RFID function in the [RFID] dialog.

➟10.2.5 [RFID] dialog
Step 3 Set the System signal according to the channel No. you use.

➟10.2.6 System information settings
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Operate the RFID function.

➟10.2.7 Action of an RFID

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

RFID controller
Connection cable GOT PLC Number of connectable 

RFID controllersModel

For the connectable RFID controllers and 
system devices, refer to the following 
Technical News.
➟List of Valid Devices Applicable for 

GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-0160)

Depending on the 
specifications of the 
RFID controller

GT27
GT25
GT23
GT21
GS25
GS21

For the system configuration 
between the GOT and the 
PLC, refer to each connection 
manual.

One RFID controller for one 
GOT

GOT

Connection cable

PLC

The system configuration between GOT and 
PLC depends on the connection type.

RFID controller
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10.2.4 Applicative use of the RFID function

Not available to GT25HS-V.

■1 Directly inputting the data to the object (numerical input or text input)
To directly input the data to the object (numerical input or text input), the setting for using the RFID function is required for 
the object.

(1) Precautions during communication
Do not store or change the send data after starting communication with the RFID controller. The communication error 
may occur.

(2) Action when the GOT receives an error
When the GOT receives an error from an RFID reader/writer, the received error is directly input to the object (numerical 
input or text input).
For details of errors, refer to the following.

➟10.2.7 ■5 Errors during communication

(3) Receiving data that is divided into segments
When the data that is divided into segments is received, the segments of the received data are not combined in one.
When the segments of data are received, each segment of data is directly input to the object (numerical input or text input) 
in each time.

(4) Timing of starting communication
The RFID Request signal is not used for directly inputting data to the numerical input or text input.
The GOT starts communication with the RFID controller after the object (numerical input or text input) is touched and a 
cursor appears.
Set the data to be used for the communication with the RFID controller before displaying the cursor on the object 
(numerical input or text input).
The following shows the data used for each protocol communication.

For the RFID Controller signal and send data area, refer to the following.
➟10.2.7 ■4 RFID Controller signal, send data area, and receive data area

(5) RFID controllers that cannot directly input data
When the following RFID controllers are used, data cannot be directly input to the object.

(a) Communication using dedicated protocols
• ICU-60S manufactured by MARS TOHKEN SOLUTION CO.LTD.
• ICU-215 (Mifare) manufactured by MARS TOHKEN SOLUTION CO.LTD.

(b) Communication using nonprocedural protocols
• RFID controllers that receive data for the first time after sending or receiving data in multiple times

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Protocol Data to be used for the communication with the RFID controller

Dedicated protocol (LSRF manufactured 
by LS Industrial Systems Co., Ltd.) RFID Controller signal (IC tag communication time, RFID reader/writer No.)

Nonprocedural protocol Send data area
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(6) Input completion notification
(a) When the input completion notification is disabled

Establishing a handshake is not required by using the External Device I/O signal and the External Device I/O Complete 
signal.
While the cursor is displayed, data is sequentially read to the object, and old data is immediately overwritten by new data 
in each time.

(b) When the input completion notification is enabled
The data cannot be input to the object until the External Device I/O Signal is turned off by the External Device I/O Complete 
signal.
For communication using nonprocedural protocols, turn off the RFID Receive signal before starting the following 
communication.
If the data input starts while the RFID Receive signal is turned on, the GOT cannot determine whether the data input is 
completed.
For the actions of the System signal and RFID Controller signal, refer to the following.

➟10.2.7 ■6 (1) Dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.)

10.2.5 [RFID] dialog

Not available to GT25HS-V.
Select [Common] → [Peripheral Setting] → [RFID] from the menu to display the setting dialog.

1) [Destination I/F]
Set the interface of the GOT.
The following shows the items to be selected.

• [Standard I/F(RS422/485)] (For GT21-P: [Standard I/F(RS422/485/232(Side))])
• [Standard I/F(RS232)] (For GT21-P: [Standard I/F(RS232(Back))])
• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

[Extend I/F(1st)], [Extend I/F(2nd)], and [Ex-tend I/F(3rd)] are not available for GT25-W, GT2505-V, GT25HS-V, GT23, 
GT21, GT Soft-GOT2000, GS25, and GS21.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Yes] is selected for 
[Read Data Direct Input to Object].

[No] is selected for [Read Data Direct Input to Object].

1)

2)

3)
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10
Item Description

[Detail Setting] button

Configure the detail setting in the [Detail Setting] window.

• [Transmission Speed(BPS)]
Select the transmission speed.
The following shows the items to be selected.
• [4800]
• [9600]
• [19200]
• [38400]
• [57600]
• [115200]

• [Data Bit]
Select the data length.
The following shows the items to be selected.
• [7bit]
• [8bit]

• [Stop Bit]
Select the stop bit length.
The following shows the items to be selected.
• [1bit]
• [2bit]

• [Parity]
Select the type for a parity check.
The following shows the items to be selected.
• [None]
• [Even]
• [Odd]

• [Sum Check]
Select whether to perform a sum check.
The following shows the items to be selected.
• [Done]
• [None]

• [Retry(Times)]
Set the number of retries to be performed when a communication error occurs.
When no response is received after the retries, the communication times out.
The range to be selected is [0] to [5].

• [Timeout Time(Sec)]
Set the interval for communication to time out.
The setting range is [3] to [30].

• [Delay Time(ms)]
Set the send delay time to lower the load of the network and the connected PLCs.
The setting range is [0] to [3000].

• [Format]
Select the communication format.
The following shows the items to be selected.
• [10]: Dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.)
• [11]: Dedicated protocol (ICU-60S manufactured by MARS TOHKEN SOLUTION CO.LTD.)
• [12]: Dedicated protocol (ICU-215 (Mifare) manufactured by MARS TOHKEN SOLUTION CO.LTD.)
• [15]: Nonprocedural protocol
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2) [Use RFID]
Select this item to enable the RFID setting.

3) [Input Completion Notification]
Select whether to enable or disable the completion notification of data input processing by the System signal (External 
Device I/O signal and External Device I/O Complete signal) and the RFID Controller signal (RFID Receive signal).
The following shows the items to be selected.

• [Disable]
• [Enable]

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

Item Description

[Read Data Direct Input to Object]

Select whether to write the data read by the RFID reader/writer into the controller, or to directly input the 
read data to the object (numerical input or text input).
• [No]: Writes the data into the controller.
• [Yes]: Directly inputs the data to the numerical input or text input.
To directly input the data to the object (numerical input or text input), the setting for using the RFID is 
required for the object.

➟8.4.5 [Numerical Input] dialog
8.5.5 [Text Input] dialog

[Device] Select a device to be used for the RFID function. Devices equivalent to 5 points starting from the selected 
device are set as the RFID Controller signal.

[Transmitted Data Points]

Set this item when using a dedicated protocol (ICU-60S or ICU-215 (Mifare) manufactured by MARS 
TOHKEN SOLUTION CO.LTD.) or a nonprocedural protocol. Set the number of pieces of data to be sent. 
The following shows the setting range.
• [0] to [10000] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)

If [No] is selected for [Read Data Direct Input to Object], the total number of [Transmitted Data Points] 
and [Received Data Points] must be 10000 or less.

• [0] to [2000] (GT21 and GS21)

[Received Data Points]

Set the number of pieces of received data. The following shows the setting range.
• [0] to [10000] (GT27, GT25, GT23, GT SoftGOT2000, and GS25)

The total number of [Transmitted Data Points] and [Received Data Points] must be 10000 or less.
• [0] to [2000] (GT21 and GS21)

[Device Points] The total of device points for [Transmitted Data Points], [Received Data Points], and the RFID Controller 
signal (5 points) is indicated.

[Header]

Select this item when using the nonprocedural protocol. Select either of the following headers suitable 
for the protocol of the RFID controller to be used. The following shows the items to be selected.
• [None]
• [STX]
• [ENQ]
• [User-specified]: Up to four bytes are settable.

Specify a value for a byte in the range of 0x00 to 0xFF.
When you select [User-specified], refer to the following.

➟10.1.5 ■1 (1) [Setting] dialog (for setting the header or terminator)

[Terminator]

Select this item when using the nonprocedural protocol. The following shows the items to be selected.
• [ETX]
• [LF]
• [CR]
• [CR+LF]
• [User-specified]: Up to four bytes are settable.

Specify a value for a byte in the range of 0x00 to 0xFF.
When you select [User-specified], refer to the following.

➟10.1.5 ■1 (1) [Setting] dialog (for setting the header or terminator)

[Data Writing Order]
Select the order of writing data into the controller device.
• [Low --> High]: The data is written into the controller device in the order of lower 8 bits to upper 8 bits.
• [High --> Low]: The data is written into the controller device in the order of upper 8 bits to lower 8 bits.

[Fill up a space when imported data 
is less than the writing points]

Select this item to fill blank devices with spaces or NULLs when the number of bytes of the received data 
by the RFID reader/writer is less than the device points set for [Received Data Points]. After selecting 
the item, select the data to fill in blank devices.
• [Space]: Fills the blank device with spaces (20H).
• [NULL]: Fills the blank device with NULLs (00H).
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10.2.6 System information settings

Not available to GT25HS-V.

■1 Setting the system information
Make sure to set one of the following System signals according to the channel No. you use.
For GT SoftGOT2000, set the System signal used for channel No.8 of the GOT.
The RFID function is unavailable without the settings.

For the details of the system information, refer to the following.
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■2 Action of the RFID function according to status of the control device
Depending on status of the control device to be used for communication, the GOT may not send or receive data to/from the 
RFID controller. For control devices for each protocol, refer to the following.

➟10.2.7 ■6 Example of the RFID action

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Channel No. System signal

Channel No.8 System signal 1-1, System signal 1-2, System signal 2-1

Channel No.5

System signal 1-2, System signal 2-3Channel No.6

Channel No.7
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10.2.7 Action of an RFID

Not available to GT25HS-V.

■1 Order of writing data into the controller
Set the order of writing the data read by the RFID reader/writer into the controller devices.

(1) Low → High
The data is written into the controller device in the order of lower 8 bits to upper 8 bits.

(2) High → Low
The data is written into the controller device in the order of upper 8 bits to lower 8 bits.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Requesting to read data

1 2 3 4 5

Receiving data D1000

2 1

4 3

5

D1001

D1002

D1003

5

Read data
12345

Stored 
data

Read bytes

Data is stored in order of lower 8 bits to upper 8 bits.

Requesting to read data

1 2 3 4 5

Receiving data D1000

21

43

5

D1001

D1002

D1003

5

Read data
12345

Stored 
data

Read bytes

Data is stored in order of upper 8 bits to lower 8 bits.
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■2 Header/terminator
Set the header and terminator of the RFID read by the RFID.

Item Description

Header

None 
(Default)

The read data is as follows when the header is not added to the head of data.

STX

The read data and STX are set as follows when STX is added to the head of data.

ENQ

The read data and ENQ are set as follows when ENQ is added to the head of data.

User-
specified

The user-specified values are prepended to the read data.
Example) When 41h, 42h, 43h, and 44h are specified

Terminator

ETX

The read data and ETX are set as follows when ETX is added to the end of data.

LF

The read data and LF are set as follows when LF is added to the end of data.

CR (Default)

The read data and CR are set as follows when CR is added to the end of data.

CR+LF

The read data and CR+LF are set as follows when CR+LF is added to the end of data.

User-
specified

The user-specified values are appended to the read data.
Example) When 61h, 62h, and 63h are specified

31h 32h 33h 34h 35h

1 2 3 4 5

Read data

31h 32h 33h 34h 35h

1

02h

STX 2 3 4 5

Read dataHeader

31h 32h 33h 34h 35h

1

05h

ENQ 2 3 4 5

Read dataHeader

Read dataHeader

A B C D

41h 42h 43h 44h

1 2 3 4 5

31h 32h 33h 34h 35h

31h 32h 33h 34h 35h

1

03h

ETX2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Ah

LF2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Dh

CR2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1

0Dh

CR

0Ah

LF2 3 4 5

Read data Terminator

31h 32h 33h 34h 35h

1 2 3 4 5

61h 62h 63h

a b c

Read data Terminator
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■3 Data to be stored in devices
The following shows how the GOT writes data to be sent or received by the RFID reader/writer into controller devices as 
string data.
Example)
• Received data: 123456789
• Order of writing data: Low → High

(1) When the number of read data is less than the set device points
Settings (Storage device: D1005, Data points: 8)

(2) When the number of read data is more than the set device points
Settings (Storage device: D1005, Data points: 4)

D1005 -0009h

: Space

D1006

D1007

D1008

D1009

D1010

D1011

D1012

21

43

65

87

3231h

3433h

3635h

3837h

2039h

2020h

2020h

  9

The GOT writes the bytes of the read data.

The GOT writes the read data in the order from lower byte.

When the number of bytes of the data read by the barcode 
reader is less than the set device points, fill blank devices 
with spaces (20h) or NULLs (00h).

Write device Stored data String data

The GOT writes the bytes of the read data.

The GOT writes the read data in the order from lower byte.

The data that exceeds the set device points is not written.

D1005 -0006h

D1006

D1007

D1008

21

43

65

3231h

3433h

3635h

Write device Stored data String data
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■4 RFID Controller signal, send data area, and receive data area
Set the RFID Controller signal for controlling data transmissions with the RFID function.
Set [Device] in the RFID dialog to automatically set the RFID Controller signal.

➟10.2.5 [RFID] dialog
The following shows a setting example of the RFID Controller signal, send data points, and receive data points.
Example) RFID settings
• Device: D1000
• Send data points: 4
• Receive data points: 8

(1) RFID Controller signal

(2) Send data area, receive data area

Device Bit number Item Description

D1000

b0 RFID Receive signal The bit turns on when the GOT receives data from the RFID controller, when the 
nonprocedural protocol is used.

b1 to b14 - -

b15 Error signal The bit turns on when the GOT receives an Error signal.

D1001

b0 to b7 IC tag communication 
time

The time (second) that the RFID reader/writer sends or receives data from/to an IC tag is 
stored in the bits when the dedicated protocol (LSRF manufactured by LS Industrial Systems 
Co., Ltd.) is used.

b8 to b15 RFID reader/writer No.
RFID reader/writer numbers that send or receive data from/to an IC tag are stored in the bits 
when the dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.) is 
used.

D1002 b0 to b15 - -

D1003
b0 to b7 Error No. Error codes are stored in the bits when errors occur.

b8 to b15 Number of errors The number of error occurrences is stored in the bits.

D1004 b0 to b15 RFID communication 
time

The communication time for the RFID function is stored in the bits.
• With the dedicated protocol

The total elapsed time of sending and receiving data is stored.
• With the nonprocedural protocol

The elapsed time of sending or receiving data is not stored.

Device Item Description

D1005 to 
D1008

Send data 
area

The data to be sent to an IC tag is stored in the devices. The number of bytes for data to be sent is stored in the start 
device.

D1009 to 
D1016

Receive 
data area

The received data from an IC tag is stored in the devices. The number of bytes for the received data is stored in the 
start device.
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■5 Errors during communication
The GOT detects errors when the errors occur while the GOT communicates with the RFID controller.
For the RFID Controller signal, refer to the following.

➟■4 RFID Controller signal, send data area, and receive data area

(1) When using a dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.)
When an error occurs, the Error signal of the RFID Controller signal turns on, the number of error occurrences is counted, 
and an error code is stored in the error No.
Check if an error occurs with the Error signal of the RFID Controller signal.
The following shows error codes to be stored in the error No.

For error codes and corrective actions other than the above, refer to the manual for the RFID controller.
After removing error causes, manually turn off the Error signal and send data again.

(2) When using a dedicated protocol (ICU-60S or ICU-215 (Mifare) manufactured by MARS TOHKEN 
SOLUTION CO.LTD.) or a nonprocedural protocol
When an error occurs, an error code is stored in the receive data area or the error No. of the RFID Controller signal.

(a) When the GOT receives an error reply from the RFID controller
When the GOT receives the error replay from the RFID controller, an error code is stored in the receive data area.
Check if an error occurs with the Error signal of the RFID Controller signal.
For errors and corrective actions, refer to the manual for the RFID controller. After removing error causes, send data again.

(b) When the GOT receives no error reply from the RFID controller
When the GOT receives no error reply from the RFID controller, the GOT turns on the Error signal of the RFID Controller 
signal, and the error code is stored in the error No.
Check if an error occurs with the Error signal of the RFID Controller signal.
The following shows error codes to be stored in the error No.

After removing error causes, manually turn off the Error signal and send data again.

Error code Description Corrective action

FFh Time out

Check if the cable is unplugged and check the RFID controller status. Take the following corrective 
actions.
• Connect the cable again.
• Correctly wire the cable.
• Turn on the RFID controller.

FEh SIO error Check the communication settings and communication environments surrounding controllers. Set 
the communication settings for the RFID controller suitable for those for the GOT.

FDh Send setting error Set the station No. and time within the setting range.

FCh Receive overflow Set the receive data area suitable for the received data size.

14h Time out or no IC tags Make the GOT send a data read request when communications are available between an RFID 
controller and an IC tag.

Error code Description Corrective action

FFh Time out

Check if the cable is unplugged and check the RFID controller status. Take the following corrective 
actions.
• Connect the cable again.
• Correctly wire the cable.
• Turn on the RFID controller.

FEh SIO error Check the communication settings and communication environments surrounding controllers.

FDh Send setting error Correctly set the send data length

FCh Receive overflow Set the receive data area suitable for the received data size.
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■6 Example of the RFID action
(1) Dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.)

Example) Settings with GT Designer3 (When the GOT is connected to the RFID controller by using channel No.8)
• System signal 1-1: D10, System signal 1-2: D11, System signal 2-1: D12
• Device: D1000, Receive data points: 4

(a) Control devices

(b) Handshake

Step 1 Set the RFID reader/writer No. and the time that the RFID reader/writer sends data to an IC tag.
Example) RFID reader/writer No: 3, Time to send data to IC tag: 2 seconds

Step 2 Turn on the RFID Request signal, and then the RFID reader/writer communicates with an IC tag.
Step 3 Data of the IC tag read by the RFID reader/writer is stored in the receive data area.
Step 4 After data is stored in the receive data area, the GOT turns on the External Device I/O signal (CH8).
Step 5 Move the data stored in the receive data area to any of the other devices.
Step 6 Check that the data is moved, and then turn on the External Device I/O Complete signal (CH8).
Step 7 The GOT turns off the External Device I/O Complete signal (CH8).
Step 8 Turn off the External Device I/O Complete signal (CH8) and the RFID Request signal (CH8).

(c) Example of the sequence program (When the GOT is connected to QCPU by using channel No.8)
After the GOT receives data from the RFID controller, make sure to turn off the External Device I/O Complete signal and 
the RFID Request signal.
When the External Device I/O Complete signal and the RFID Request signal are on, the GOT cannot read the data.
Create a sequence program so that the External Device I/O Complete signal and the RFID Request signal turn off.

Before using example programs
For applying the example programs in this manual to the actual system, make sure that the target system has 
no troubles on the control.

Device Item

System information
External Device I/O Complete signal (CH8)(System signal 1-1.b6) RFID Request signal (CH8) (System signal 1-
2.b1), External Device I/O signal (CH8)(System signal 2-1.b6)
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

RFID Controller signal
IC tag communication time, RFID reader/writer No.
➟■4 RFID Controller signal, send data area, and receive data area

User-created program
D1005
→

R1005

GOT Sending data/
Receiving data

RFID Controller signal 
(IC tag communication time, 
RFID reader/writer No.)

'3','2'

Receive data area 06h,00h,'A','B','1','2','3','4'

RFID Request signal (CH8) 
(System signal 1-2.b1)

External Device I/O 
signal (CH8) 
(System signal 2-1.b6)

External Device I/O Complete 
signal (CH8) 
(System signal 1-1.b6)

1.

2.

3.

4.

5.

6.

7.

8.

8.
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Signal to be used in a sequence program
• RFID reader/writer No.3 read command: M200

(2) Dedicated protocol (ICU-60S or ICU-215 (Mifare) manufactured by MARS TOHKEN SOLUTION 
CO.LTD.)
Example) Settings with GT Designer3 (When the GOT is connected to the RFID controller by using channel No.8)

• System signal 1-1: D10, System signal 1-2: D11, System signal 2-1: D12
• Device: D1000, Send data points: 30, Receive data points: 30

(a) Control devices

(b) Handshake

Step 1 Set the data to be sent to the RFID controller in the send data area.
Set the data suitable for the protocol of the RFID controller to be used.
Example) Reading record No.3 by "rf_read" command

Step 2 Turn on the RFID Request signal, and then the RFID reader/writer communicates with an IC tag.
Step 3 Data of the IC tag read by the RFID reader/writer is stored in the receive data area.
Step 4 After data is stored in the receive data area, the GOT turns on the External Device I/O signal (CH8).
Step 5 Move the data stored in the receive data area to any of the other devices.
Step 6 Check that the data is moved, and then turn on the External Device I/O Complete signal (CH8).
Step 7 The GOT turns off the External Device I/O Complete signal (CH8).
Step 8 Turn off the External Device I/O Complete signal (CH8) and the RFID Request signal (CH8).

D1005
D1000.F

D11.1

D11.1

K4

D10.6

D10.6

D10.6

D12.6

D12.6

RST

RST

SET

SET

R1005

M200
0

24

60

MOVP

BMOVP

D1001H302 Set the RFID reader/writer No. and the time that the RFID 
reader/writer sends data to an IC tag. 
(RFID reader/writer No: 3, Time to send data to IC tag: two seconds) 
Turn on the RFID Request signal, and then the RFID 
reader/writer communicates with an IC tag to read data.

The data is stored in the receive data area. 
Move the data to any of the other devices after 
the External Device I/O signal (CH8) turns on. 

After moving the data, turn on the External Device I/O Complete 
signal (CH8).

Turn off the External Device I/O Complete signal (CH8) and 
the RFID Request signal (CH8).

Device Item

System information
External Device I/O Complete signal (CH8)(System signal 1-1.b6) RFID Request signal (CH8) (System signal 1-2.b1), 
External Device I/O signal (CH8)(System signal 2-1.b6)
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

User-created program
D1036
→

R1036

GOT Sending data/
Receiving data

Send data area 41h,01h,03h

Receive data area 14h,00h,41h,12h,
00h,01h,'A','B', to 'P'

RFID Request signal (CH8) 
(System signal 1-2.b1)

External Device I/O 
signal (CH8) 
(System signal 2-1.b6)

External Device I/O Complete 
signal (CH8) 
(System signal 1-1.b6)

1.

2.

3.

4.

5.

6.

7.

8.

8.
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(c) Example of the sequence program (When the GOT is connected to QCPU by using channel No.8)
After the GOT receives data from the RFID controller, make sure to turn off the External Device I/O Complete signal and 
the RFID Request signal.
When the External Device I/O Complete signal and the RFID Request signal are on, the GOT cannot read the data.
Create a sequence program so that the External Device I/O Complete signal and the RFID Request signal turn off.

Before using example programs
For applying the example programs in this manual to the actual system, make sure that the target system has 
no troubles on the control.

Signal to be used in a sequence program
• Record No.3 read command: M200

D1036
D1000.F

D11.1

K10

D10.6

D10.6

D10.6

D12.6

D12.6

RST

RST

SET

R1036

M200
0

28

64

MOVP

BMOVP

D1005K3

D11.1SET

MOVP D1007H3

MOVP D1006H141 Make the setting to read the record. 
Turn on the RFID Request signal, and then the RFID 
reader/writer communicates with an IC tag to read data.

The data is stored in the receive data area. 
Move the data to any of the other devices after 
the External Device I/O signal (CH8) turns on.

After moving the data, turn on the External Device 
I/O Complete signal (CH8).

Turn off the External Device I/O Complete signal (CH8) 
and the RFID Request signal (CH8).
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(3) Nonprocedural protocol
Example) Settings with GT Designer3 (When the GOT is connected to the RFID controller by using channel No.8)

• System signal 1-1: D10, System signal 1-2: D11, System signal 2-1: D12
• Device: D1000, Send data points: 5, Receive data points: 8

(a) Control devices

(b) Handshake

Step 1 Set the data to be sent to the RFID controller in the send data area.
Set the data suitable for the protocol of the RFID controller to be used.
Example) "07h, 00h, 02h, '0', '3', 'G', '0', '2', 03h"

Step 2 Turn on the RFID request signal (CH8), and then the RFID reader/writer sends the data stored in the send 
data area to the IC tag.

Step 3 The GOT turns on the External Device I/O signal (CH8).
Step 4 Check that the External Device I/O signal (CH8) is on, and then turn on the External Device I/O Complete 

signal (CH8).
The GOT turns off the External Device I/O Complete signal (CH8).
Turn off the External Device I/O Complete signal (CH8).

Step 5 The IC tag sends data to the RFID reader/writer, and the data is stored in the receive data area.
Step 6 The GOT turns on the RFID Receive signal.
Step 7 Move the data stored in the receive data area to any of the other devices.
Step 8 Turn off the RFID Request signal (CH8) and the RFID Receive signal.

(c) Example of the sequence program (When the GOT is connected to QCPU by using channel No.8)
Be sure to turn off the RFID Request signal and the RFID Receive signal before the GOT sends the next data read 
request to the RFID controller.
When the RFID Request signal and the RFID Receive signal are on, the GOT cannot communicate with the RFID 
controller.
Create a sequence program so that the RFID Request signal and the RFID Receive signal turn off.

Device Item

System information

External Device I/O Complete signal (CH8)(System signal 1-1.b6) RFID Request signal (CH8) (System 
signal 1-2.b1), External Device I/O signal (CH8)(System signal 2-1.b6)
➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System 

Information])

RFID Controller signal
IC tag communication time, RFID reader/writer No.
➟■4 RFID Controller signal, send data area, and receive data area

User-created program
D1010
→

R2017

GOT Sending 
data

Receiving 
data

RFID Controller signal 
(RFID Receive signal)

07h,00h,02h,'0',
'3','G','0','2',03h

Receive data area

Send data area

0Dh,00h,02h,'0','3','D','*',
'A','B','1','2','3','4','*',03h

RFID Request signal (CH8) 
(System signal 1-2.b1)

External Device I/O 
signal (CH8) 
(System signal 2-1.b6)
External Device I/O Complete 
signal (CH8) 
(System signal 1-1.b6)

1.

2.

3.

4.

5.

6.

7.

8.

8.
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Before using example programs
For applying the example programs in this manual to the actual system, make sure that the target system has 
no troubles on the control.

Signal to be used in a sequence program
• Data send command: M201

10.2.8 Precautions

Not available to GT25HS-V.

■1 Precautions for hardware
When the RFID controller is used with [Standard I/F(RS232)], 5V power supply from the GOT should become enabled on 
some RFID controllers.
For applicable RFID controllers, refer to Technical News GOT-A-0160 "List of Valid Devices Applicable for GOT2000 Series 
and GOT SIMPLE Series (for Overseas)" separately available, or contact your local distributor.

D1010
D1000.FD1000.0

D11.1

K8

D10.6

D11.1

D12.6

D10.6

D12.6

SET

RST

SET

R2017

M201
0

55

31

76

MOVP

BMOVP

D1005H7

MOVP D1006H3002

MOVP D1007H4733

MOVP D1008H3230

MOVP D1009H3

D10.6RST

D1000.0RST

Write data to be sent in the send data area.

Turn on the RFID Request signal, 
and send the data.

After the External Device I/O signal (CH8) turns on, 
turn on the External Device I/O Complete signal (CH8).

After the External Device I/O signal (CH8) turns off, 
turn off the External Device I/O Complete signal (CH8).

After the RFID Receive signal turns on, move the data stored 
in the receive data area to any of the other devices.

Turn off the RFID Receive signal.

Turn off the RFID Request signal.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.2 Using an RFID with the GOT (RFID Function)

10 - 37



10.2.9 Relevant settings

Not available to GT25HS-V.
Set the relevant settings other than the specific settings for the RFID function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu to display the [Environmental 
Setting] dialog.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Target 
CH Function Setting item

CH5

Turning on this signal requests the RFID controller to read data. (Read device: System signal 1-2.b4) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b0). (Read device: System signal 
1-2.b3) [System Signal 1-2]

Notifying that the data read by the RFID reader/writer is stored into the specified device when the dedicated protocol 
is used. Notifying that sending data to the RFID controllers is completed when the nonprocedural protocol is used. 
(Write device: System signal 2-3.b0)

[System Signal 2-3]

CH6

Turning on this signal requests the RFID controller to read data. (Read device: System signal 1-2.b7) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b1). (Read device: System signal 
1-2.b6) [System Signal 1-2]

Notifying that the data read by the RFID reader/writer is stored into the specified device when the dedicated protocol 
is used. Notifying that sending data to the RFID controllers is completed when the nonprocedural protocol is used. 
(Write device: System signal 2-3.b1)

[System Signal 2-3]

CH7

Turning on this signal requests the RFID controller to read data. (Read device: System signal 1-2.b10) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-3.b2). (Read device: System signal 
1-2.b9) [System Signal 1-2]

Notifying that the data read by the RFID reader/writer is stored into the specified device when the dedicated protocol 
is used. Notifying that sending data to the RFID controllers is completed when the nonprocedural protocol is used. 
(Write device: System signal 2-3.b2)

[System Signal 2-3]

CH8

Turning on this signal requests the RFID controller to read data. (Read device: System signal 1-2.b1) [System Signal 1-2]

Turning on this signal turns off the External Device I/O signal (System signal 2-1.b6). (Read device: System signal 
1-1.b6) [System Signal 1-1]

Notifying that the data read by the RFID reader/writer is stored into the specified device when the dedicated protocol 
is used. Notifying that sending data to the RFID controllers is completed when the nonprocedural protocol is used. 
(Write device: System signal 2-1.b6)

[System Signal 2-1]

Function Setting item

Notifying that external authentication of operator authentication function succeeds. (Write 
device) GS240.b0

Notifying that external authentication of operator authentication function fails. (Write device) GS240.b1

Notifying that the login screen for the external authentication of operator authentication function 
is displayed. (Write device) GS240.b14

Notifying that the object is in the ready state for the data read by the barcode reader and the 
RFID to be directly input. (Write device) GS243.b15
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10.3 Operating a Personal Computer by Using the GOT (Remote 
Personal Computer Operation (Ethernet))

10.3.1 Overview of the remote personal computer operation function (Ethernet)

The remote personal computer operation (Ethernet) enables you to operate the personal computer by using the GOT via 
Ethernet.

■1 Operating the personal computer on the GOT screen.

Using the USB mouse/keyboard function enables you to use the USB mouse and USB keyboard for the remote personal 
computer operation (Ethernet).
For the details of the USB mouse/keyboard function, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])

■2 Remote personal computer operation (Ethernet) with multiple GOTs
When the personal computer with the server OS is used, the terminal server function of the personal computer enables 
the multiple GOTs to perform the remote personal computer operation (Ethernet).
When the personal computer screen appears on the GOT, the GOT logs on to the terminal server automatically.
After the logon, the terminal server displays the individual screen of the personal computer on each GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

USB hub

GOT

Personal computer

Personal 
computer 
screen

Mouse/keyboard 
operation

USB keyboard USB mouse

Personal computer operates 
according to the operation 
on the GOT

Operating the personal 
computer screen displayed 
on the GOT

GOT2

Personal computer with the server

Display 
screen 2

Operation

OperationDisplay 
screen 3

Operation
Display 
screen 1

Terminal 
server

GOT1 GOT3

Displaying individual personal computer screen on each GOT

Display screen 1 Display screen 3Display screen 2
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10.3.2 Specifications of the remote personal computer operation (Ethernet)

■1 System application (extended function)
To use the remote personal computer operation (Ethernet), a system application (extended function) of [PC Remote 
Operation(Ethernet)] is required.
Selecting [Use PC Remote Operation (Ethernet)] in the [PC Remote Operation] dialog incorporates the application into the 
package data automatically.

➟10.3.4 [PC Remote Operation] dialog

■2 Remote personal computer operation (Ethernet) to be set for one project
One remote personal computer operation function is available for one project.

■3 License number registration
To use the remote personal computer operation (Ethernet), register a license number on the GOT.
For how to register the license number, refer to the following.

➟GOT2000 Series User's Manual (Utility)
When the license number is not registered, the 30 minutes of trial for the function is available upon connection to the VNC 
server.
Up to 30 trials are available.
To start a trail again, turn off and then on the GOT.
After 30 trials, you must register the license number to use the function.

■4 Required software to be installed
Software you need to install depends on the number of the connected GOT and personal computer.

(1) VNC server software
Download UltraVNC (Win32 Full version) from the following website.
http://www.uvnc.com/
Note that the above website may be changed without notification.
For the applicable UltraVNC version, refer to the following Technical Bulletin.

➟List of VNC Servers Supporting the Remote Personal Computer Operation (Ethernet) Function Validated to 
Operate with the GOT2000 Series(GOT-A-0110)

(2) Windows terminal server function
The terminal server function with the following OS is applicable.

• Windows Server 2012 R2 (x64): Automatic logon to the terminal server is not supported.
• Windows Server 2003

(3) Encryption software (OpenSSL)

For the operating environment of the software and its downloading, refer to the following website.
http://www.slproweb.com/products/Win32OpenSSL.html
Note that the above website may be changed without notification.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Number of GOTs Software Installation procedure

One VNC server software ➟10.3.5 ■1 For the remote personal computer operation (Ethernet) with 
one GOT

Two or more
• Windows terminal server function
• Encryption software
• Terminal service function software

➟10.3.5 ■2 For the remote personal computer operation (Ethernet) with 
multiple GOTs

Name Manufacturer Version

Win32OpenSSL The OpenSSL Project
Depends on the terminal server function to be used.
• Windows Server 2012 R2 (x64): Latest version of 1.0.2
• Windows Server 2003: Latest version of 0.9.8
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(4) Terminal service function software (RDPGateway(rdp2vnc))

Refer to the following website to download RDPGateway (rdp2vnc).
https://csps.hitachi-solutions.co.jp/rdp2vnc/
Note that the above website may be changed without notification.

■5 Display modes of the personal computer screen on the GOT
The personal computer screen on the GOT is displayed in the window display mode or full screen mode.
Use GS465.b8 to switch between the display modes.

➟12.1.3 GOT special register (GS)
If you do not use GS465.b8, the personal computer screen on the GOT opens in the window display mode.

• Window display mode
The screen is layered on part of the base screen.
The toolbar is always displayed at the top of the personal computer screen on the GOT.

• Full screen mode
The screen is displayed on the entire base screen.
The toolbar is displayed when you first open the screen or touch the toolbar display touch area.
When the resolution is the same between the GOT and the personal computer, hiding the scroll bars with GS465.b7 
displays the entire personal computer screen on the GOT.

The following shows the specifications of the display modes.

*1 For system windows, refer to the following.

➟5.2.1 ■2 (5) Using an overlap window as the system window

Name Manufacturer

RDPGateway (rdp2vnc) Hitachi Solutions, Ltd.

Display mode Applicable graphics mode Number of system 
windows *1 Operating procedure

Window display mode
• GOT Graphic Ver.1
• GOT Graphic Ver.2

1 ➟10.3.7 Operation on the personal computer screen on the 
GOT in the window display mode

Full screen mode • GOT Graphic Ver.2 2 ➟10.3.8 Operation on the personal computer screen on the 
GOT in the full screen mode

Window display mode Full screen mode
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■6 Switching the personal computer screen on the GOT
When the GOT connected with multiple personal computers displays a remote screen window, tuning on GS465.b10 
enables switching between personal computer screens without closing the remote screen window.

Touch the function switch for which another personal computer is specified to switch the displayed personal computer 
screen to the specified personal computer screen without closing the remote screen window.
When GS465.b10 is off, the displayed personal computer screen is not switched and an error message is displayed.
Touch the close button to close the displayed personal computer screen, and then touch the special function switch for 
which another personal computer is specified to open the screen of that personal computer.

When the connected personal computer is switched without closing the remote screen window, only the operation log 
[Touch switch: Application switching] is output.

Displaying the screen of 
personal computer 1

Touch the special function switch 
for which personal computer 2 is specified.

Switching to 
personal computer 2

Computer
 1

PC remote operation (Ethernet)

Computer
 2

PC remote operation (Ethernet)

Computer
 1

Computer
 2

Displaying the screen of 
personal computer 1

Touch the special function switch 
for which personal computer 2 is specified.

Switching to 
personal computer 2

Computer
 1

PC remote operation (Ethernet)

Computer
 2

PC remote operation (Ethernet)

Computer
 1

Computer
 2

Computer
 1

Computer
 2

Touch the close button of the
 personal computer screen.
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10.3.3 How to use the remote personal computer operation (Ethernet)

■1 System configuration
The following shows the system configuration of the personal computer.

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 for a cascade connection (within 500 m)
• 100BASE-TX: Up to 2 for a cascade connection (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Not available to GT2505-V and GT25HS-V.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal 
computer

Connection cable*1*2,
wireless LAN access point

Maximum 
segment 
length*3

GOT

PLC

Number of 
connectable 

personal 
computersOption GOT 

model

Select by 
each user

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded 
twisted pair cable (UTP): Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 
and 5e

100m

- (Built into GOT)
GT27
GT25
GS25

For the system 
configuration 
between the 
GOT and the 
PLC, refer to 
each 
connection 
manual.

One personal 
computer for 
one GOT

GT25-J71E71-100
GT27

GT25 *6

- - GT25-WLAN
GT27 *4

GT25 *4*6

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN access 
points and system devices, refer to the 
following Technical News.
➟List of Valid Devices Applicable for 

GOT2000 Series and GOT SIMPLE Series 
(for Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *5

GT25 *5*6

GS25 *5

The system configuration between GOT and PLC 
depends on the connection type.

Personal 
computer GOT PLC

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.3 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation (Ethernet))

10 - 43



■2 Setting procedure
The following shows how to configure the settings for the remote personal computer operation (Ethernet).

Step 1 Connect the personal computer to the GOT.

➟■1 System configuration
Step 2 Set the destination I/F for the Ethernet download in [Destination I/F] in [Ethernet Download] in the peripheral 

device setting ([PC (Data Transfer)] dialog).

➟4.8.1 [PC (Data Transfer)] dialog
Step 3 Configure the settings for the remote personal computer operation (Ethernet) in the [PC Remote Operation] 

dialog.

➟10.3.4 [PC Remote Operation] dialog
Step 4 Set the GOT Ethernet interface.

➟5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])
Step 5 Arrange the special function switch on the GT Designer3 screen, then select [PC Remote Operation 

(Ethernet)] for the switch action.
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog
Step 6 Install the software on the personal computer.

➟10.3.5 Installation of the software
Step 7 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 8 Register the license number on the GOT.

For how to register the license number, refer to the following.
➟GOT2000 Series User's Manual (Utility)

Step 9 Open the personal computer screen on the GOT.

➟10.3.6 Personal computer screen on the GOT
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10.3.4 [PC Remote Operation] dialog

Select [Common] → [Peripheral Setting] → [PC Remote Operation] from the menu to display the setting dialog.

1) Remote personal computer operation (Ethernet)
Set the actions of the remote personal computer operation (Ethernet).

2) Remote personal computer operation (Serial)
No setting is required.

Item Description

[Use PC Remote Operation (Ethernet)] Select this item to enable the remote personal computer operation (Ethernet).

[Mouse Cursor Display]

Select how to display the mouse cursor on the GOT when the USB mouse is used.
• [GOT and server PC]

Select this item to display the mouse cursor on the GOT and the mouse cursor on the 
personal computer.

• [GOT Only]
Select this item to display only the mouse cursor on the GOT.
The mouse cursor on the personal computer is not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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10.3.5 Installation of the software

For the remote personal computer operation (Ethernet) with GOT, install the following software on the personal computer, 
and configure the settings.

■1 For the remote personal computer operation (Ethernet) with one GOT
Install the VNC server software on the personal computer.
The following shows how to install the software and configure the settings.

(1) How to install Remote Personal Computer Operation Driver (MES_2X)
Step 1 Execute the downloaded file, and start the installer.
Step 2 The setup window appears.

Click the [Next] button until the [License Agreement] screen is displayed.
Confirm the description in the screen, and then select [I accept the agreement].

Step 3 Click the [Next] button until the [Select Destination Location] screen is displayed.
In the screen, select the location where the software is installed.

Step 4 The [Select Components] screen appears.
Select [Full installation] or [UltraVNC Server Only].

Step 5 The [Select Start Menu Folder] screen appears.
Select a start menu folder to create a shortcut.

Step 6 The confirmation window appears to confirm whether to download the following software.
(For Windows 10, the confirmation window does not appear. Proceed to step 7.)

• Optional non-GPL addons recommended for Vista
Download the software when using Windows Vista.

• Optional non-GPL Mirror Driver
Download the software.

Step 7 The [Select Additional Tasks] screen appears.
• Select [Register UltraVNC Server as a system service].

UltraVNC is registered in the system service.
• Select [Start or restart UltraVNC service].

The UltraVNC service becomes available.
• To create a shortcut icon on the desktop, select [Create UltraVNC desktop icons].
• To open the file with the extension of .vnc by using UltraVNC Viewer, select [Associate UltraVNC Viewer 

with the .vnc file extension].
Step 8 The confirmation screen for installation appears.

Confirm the description in the screen, and then click the [Install] button.
Installation of UltraVNC starts.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Settings
The following shows the setting method by using UltraVNC version 1.0.5.6 as an example.

Step 1 When UltraVNC is not started, click [UltraVNC]→[UltraVNC Server] from the start menu to start UltraVNC.
Step 2 Right-click the UltraVNC icon in the notification area, and select [Admin Properties].

The setting window appears, and then configure the settings as shown below.
The items to be displayed differ depending on the UltraVNC version.
No setting is required for the items which are not explained in the following.

1) [Incoming connections]
Configure the connection settings between the GOT and the VNC server.

2) [When Last Client Disconnects]
Set the action when the last connected VNC client (GOT) is disconnected.
Select [Lock Workstation(W2K)].

3) [Multi viewer connections]
Set the action when multiple VNC clients (GOTs) require to be connected to the VNC server.
Select [Keep existing connections].

4) [Authentication]
Configure the authentication setting to connect the GOT to the VNC server.

Item Description

[Accept Socket Connection] Select this item to accept the socket connection.
Without selecting, the GOT cannot be connected to the VNC server.

[Display Number or Ports to use]

Set a port number for the connection.
[Display]: 
Set the port number with a display number. The port number is the set display number with 
5900 added.
[Ports(Main)]: 
Set the port number without the display number.
The setting range is [1024] to [65535].

Item Description

[VNC Password] Set a password for the VNC server.

2)

3)

4) 5)

1)
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5) [Misc.]
Configure the settings other than the above.

Step 3 Right-click the UltraVNC icon in the notification area, and select [Properties].
The setting window appears, and then select [Video Hook Driver].
This setting is not required if the setting item is not displayed.

■2 For the remote personal computer operation (Ethernet) with multiple GOTs
For the remote personal computer operation (Ethernet) with multiple GOTs, use the terminal server function of the personal 
computer.
To use the the terminal server function, install the following software.
• Windows terminal server function
• Encryption software (OpenSSL)
• Terminal service function software (RDPGateway(rdp2vnc))

(1) How to install the software for terminal server function
Step 1 Click [Start] → [Settings] → [Control Panel].
Step 2 The [Control Panel] window appears.

Click [Add or Remove Programs].
Step 3 The [Add or Remove Programs] window appears.

Click [Add/Remove Windows Components].
Step 4 The [Windows Components Wizard] window appears.

Select [Terminal Server] and [Terminal Server Licensing] in the component list.
Step 5 Click the [Next] button.

Installation of the software for terminal server function starts.
Step 6 After the installation is completed, the [Terminal Server Licensing] window appears.

Right-click a server name you register, and select [Activate Server].

(2) Terminal server function settings
Set the following items in the terminal server function settings.
For how to configure the terminal server settings, refer to the Windows manual.

(a) User name and password
Register a user name and password to log on to the terminal server.
Set the user name with up to 20 characters, and the password with up to 127 characters.
One-byte alphanumeric characters, one-byte space, and symbols (excluding "/[]:; | =,+*?<>\) are available for the user 
name. One-byte alphanumeric characters, one-byte space, and the following symbols are available for the password.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~

(b) Logon screen display settings
Configure the setting so that the logon screen is displayed on the personal computer with the terminal server when the 
GOT is connected to the personal computer.
If the logon screen is not displayed on the terminal server, unexpected actions may occur on the personal computer.

Item Description

[Remove Aero (Vista)] Select this item to disable Windows Aero while the GOT is connected to the viewers.
Set this item when using Windows Aero.

[Remove Wallpaper for Viewers] Select this item not to display a wallpaper while the GOT is connected to the viewers.

[Default Server Screen Scale] Set the default value of the server screen display magnification.
Make sure to set 1 as the default value.
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(c) Disabling the network level authentication (for Windows Server 2012 R2 (x64))
Step 1 From the Windows start menu, select [Control Panel].
Step 2 In the [Control Panel] window, select [System] → [Remote Settings] from the menu.
Step 3 In the [System Properties] window, select the [Remote] tab and clear [Allow connections only from 

computers running Remote Desktop with Network Level Authentication].

(3) How to install the encryption software
Step 1 Execute the downloaded file, and start the installer.
Step 2 The setup window appears.

Click the [Next] button until the [License Agreement] screen is displayed. Confirm the description in the 
screen, and then select [I accept the agreement].

Step 3 Click the [Next] button until the [Select Destination Location] screen is displayed.
In the screen, select the location where the software is installed.

Step 4 The [Select Start Menu Folder] screen appears.
Select a start menu folder to create a shortcut.

Step 5 The [Select Additional Tasks] screen appears.
Select a directory where the DLL file for OpenSSL is copied.

Step 6 The confirmation screen for installation appears.
Confirm the description in the screen, and then click the [Install] button.
Installation of OpenSSL starts.

Step 7 After the installation is completed, the confirmation screen for donation appears.
Confirm the description in the screen, and then select or clear the check box.
When you do not make a donation, clear the check box.

(4) Encryption software settings
No setting is required.

(5) How to install the terminal service function software
Step 1 Decompress the downloaded file.
Step 2 Open the rdp2vnc folder, and execute the install2003jp.bat.

The command prompt starts.
Step 3 Enter the name of the personal computer where RDPGateway (rdp2vnc) is installed.
Step 4 Enter the name and password of the user with administrator authority.

Installation of the software starts.
Step 5 After the installation is completed, press the Enter key to exit the command prompt.
Step 6 Select [Start] → [Control Panel] → [Administrative Tools] → [Services].

The [Services] window appears.
Check that [rdp2vnc Server] is registered.

Step 7 Open the drive C to check that the [rdp2vnc] folder is created.

(6) Terminal service function software settings
Step 1 Select [Start] → [Control Panel] → [Administrative Tools] → [Services].

The [Services] window appears.
Right-click [rdp2vnc Server], and select [Properties].

Step 2 The property setting window appears.
Click the [Recovery] tab to set the following for [First failure], [Second failure], and [Subsequent failures].

• [Restart the Service]
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10.3.6 Personal computer screen on the GOT

■1 How to open the personal computer screen on the GOT
Open the personal computer screen on the GOT with a special function switch.
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog

■2 Changing the display mode
Use GS465.b8 to switch between the display modes of the personal computer screen on the GOT.

• When GS465.b8 is on: Full screen mode
• When GS465.b8 is off: Window display mode

If you switch the display mode, do so before opening the personal computer screen on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.3.7 Operation on the personal computer screen on the GOT in the window display 
mode

Touch any part of the screen to move the mouse cursor and left-click.
You can drag on-screen items with a touch-and-slide operation.

1) Click switching button
Touch this button to switch the click operation to the right-click.
After switching, clicking any part of the screen cancels the right-click.

2) Zoom in button, Zoom out button
These buttons change the display magnification of the screen.
The zoom in button zooms in the displayed screen.
The zoom out button zooms out the displayed screen.

3) [KBD] button
Touch this button to display the soft keyboard.
Select the soft keyboard type in the [Special Function Switch] dialog.

➟8.2.9 [Special Function Switch] dialog
4) [C+E] button

This button performs the same operation as that of holding down the [Ctrl] key and the [ESC] key simultaneously.
5) [CAD] button

This button performs the same operation as that of holding down the [Ctrl] key, the [Alt] key, and the [Del] key 
simultaneously.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2 GOT Graphic Ver.1

2) 3) 4) 5)1) 2) 3) 4) 5)1)
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■1 Soft keyboard operation

Touching and holding a key on the soft keyboard performs the same operation as that performed by repeating the input.
(The [SFT] key, the [ALT] key, the [CTR] key, and the [CAPS] key are excluded.)
Touching the [SFT] key, the [ALT] key, or the [CTR] key once keeps the state of holding down the key.
To release the key, perform one of the following operations.

• Touch the same key again.
• Touch any key other than the [SFT] key, the [ALT] key, or the [CTR] key.

The [CAPS] key is held down or released each time the key is touched.
Touching the title bar moves the soft keyboard as well as the key window.
Touching the [×] button closes the soft keyboard.
The Ultra VNC server does not support switching character string using the character type switching key.

■2 Operation of a USB mouse and USB keyboard
For details on the USB mouse and USB keyboard, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])

Japanese 106 keyboard English 101 keyboard

Character type switching key
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10.3.8 Operation on the personal computer screen on the GOT in the full screen mode

Touch any part of the screen to move the mouse cursor and left-click.
You can drag on-screen items with a touch-and-slide operation.

1) Toolbar display touch area
The area 40 dots from the top edge, excluding the area 32 dots from the right edge of the personal computer screen 
on the GOT, applies to the toolbar display touch area.
Touch this area to display the toolbar in the location it was previously displayed.
The toolbar is displayed at the top or bottom of the screen.
If no operation is performed on the toolbar for a specified time period, the toolbar is hidden.
The toolbar size is 640 dots × 40 dots regardless of the screen resolution.

2) Toolbar display position switching button
Switches the toolbar display position either at the top or at the bottom of the screen.

3) Click switching button
Touch this button to switch the click operation to the right-click.
After switching, clicking any part of the screen cancels the right-click.

4) Zoom in button, Zoom out button
These buttons change the display magnification of the screen.
The zoom in button zooms in the displayed screen.
The zoom out button zooms out the displayed screen.

5) [KBD] button
Touch this button to display the soft keyboard.
Select the soft keyboard type in the [Special Function Switch] dialog.

➟8.2.9 [Special Function Switch] dialog
6) [C+E] button

This button performs the same operation as that of holding down the [Ctrl] key and the [ESC] key simultaneously.
7) [CAD] button

This button performs the same operation as that of holding down the [Ctrl] key, the [Alt] key, and the [Del] key 
simultaneously.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
GOT Graphic Ver.2

1)

2) 3) 4) 5) 6) 7)
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■1 Soft keyboard operation

Touching and holding a key on the soft keyboard performs the same operation as that performed by repeating the input.
(The [SFT] key, the [ALT] key, the [CTR] key, and the [CAPS] key are excluded.)
Touching the [SFT] key, the [ALT] key, or the [CTR] key once keeps the state of holding down the key.
To release the key, perform one of the following operations.

• Touch the same key again.
• Touch any key other than the [SFT] key, the [ALT] key, or the [CTR] key.

The [CAPS] key is held down or released each time the key is touched.
Touching the title bar moves the soft keyboard as well as the key window.
Touching the [×] button closes the soft keyboard.
The Ultra VNC server does not support switching character string using the character type switching key.

■2 Operation of a USB mouse and USB keyboard
For details on the USB mouse and USB keyboard, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])

Japanese 106 keyboard English 101 keyboard

Character type switching key
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10.3.9 Precautions

■1 Precautions when changing the graphics mode
(1) Settings for writing the package data

When writing the package data of a project for which the graphics mode is changed into the GOT, perform one of the 
following operations.
• Select [Synchronize] in [Write Mode] of [Write Option].

➟4.8.3 ■3 [Write Option] dialog
• Delete the package data in [GOT Read], and then rewrite the package data.

➟4.8.2 ■2 (3) Reading the drive information

■2 Precautions for use
(1) Force close of the personal computer screen on the GOT

The personal computer screen on the GOT is forcedly closed in the following cases.
• When starting the utility
• When starting system applications (extended functions), including the sequence program monitors, by using a special 
function switch

To use the remote personal computer operation (Ethernet) after the monitor screen appears, open the personal computer 
screen on the GOT again by using the special function switch.

(2) Mouse cursor display when the USB mouse is installed or removed
When the USB mouse is installed or removed while the personal computer screen on the GOT is displayed, the mouse 
cursor is displayed as shown below.
To display the mouse cursors according to the GT Designer3 settings, close the personal computer screen on the GOT, 
and then open the screen again.

(3) Window display when the soft keyboard is used

The following windows are not displayed while the soft keyboard is being displayed.
• Key window for numerical input object, text input object, and other objects
• Comment window

(4) Display position of the personal computer screen on the GOT in the window display mode

When all the following conditions are satisfied, the personal computer screen on the GOT is displayed outside the GOT 
screen, and therefore cannot be moved or exited.
• [Display windows beyond the screen area] in the [Environmental Setting] window is selected.
• The maximum value is set to [Window Position] in the [Special Function Switch] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Mouse cursor display setting Mouse cursor display method

GOT and server PC
Installed Both the mouse cursor on the GOT and the mouse cursor on the personal computer are displayed.

Removed Only the mouse cursor on the personal computer is displayed.
(The mouse cursor on the GOT is not displayed.)

GOT Only
Installed Both the mouse cursor on the GOT and the mouse cursor on the personal computer are displayed.

Removed The mouse cursors are not displayed.
(Neither the mouse cursor on the GOT nor the mouse cursor on the personal computer are displayed.)

GOT Graphic Ver.1

GOT Graphic Ver.2
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10.3.10 Relevant settings

Set the relevant settings other than the specific settings for the remote personal computer operation function (Ethernet) as 
required.
The following shows the functions that are available by the relevant settings.

■1 GOT environmental settings [Screen Switching/Windows]

Select [Common] → [GOT Environmental Setting] → [Screen Switching/Windows] from the menu.
➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Displaying window beyond the GOT screen (window display mode only) [Display windows beyond the screen area]

GOT Graphic Ver.2

Function Setting item

Hiding the [CAD] button in the personal computer screen on the GOT GS465.b0

Hiding the [C+E] button in the personal computer screen on the GOT GS465.b1

Hiding the [KBD] button in the personal computer screen on the GOT GS465.b2

Hiding the zoom in button and the zoom out button in the personal computer screen on the GOT, and fixing the display 
magnification to 100% GS465.b3

Applying the display magnification specified for the special function switch that calls the personal computer screen. 
This function is enabled when GS465.b3 is turned on to fix the magnification to 100%. GS465.b5

Hiding the click switching button of the personal computer screen on the GOT GS465.b6

Hiding the scroll bars of the personal computer screen on the GOT GS465.b7

Switching the display mode of the personal computer screen on the GOT GS465.b8

Enabling switching between personal computer screens without closing the remote screen window displayed on the 
GOT connected with multiple personal computers. GS465.b10
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10.4 Operating a Personal Computer by Using the GOT (Remote 
Personal Computer Operation (Serial))

Not available to GT2705-V.

10.4.1 Overview of the remote personal computer operation function (Serial)

The remote personal computer operation (Serial) enables you to remotely operate the mouse pointer of a personal 
computer by touching the personal computer screen displayed on the GOT.
To display the personal computer screen on the GOT, use one of the following functions.

• Video/RGB display object
• RGB display function

Using the USB mouse and keyboard function enables you to use the USB mouse and keyboard, for the remote personal 
computer operation (Serial).
For the details of the USB mouse/keyboard function, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The GOT displays the personal 
computer screen.

The coordinates of the position touched on the GOT and 
the touch status are sent to the personal computer for 
operating the mouse pointer.
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10.4.2 Specifications of the remote personal computer operation (Serial)

■1 System application (extended function)
To use the remote personal computer operation (Serial), a system application (extended function) of [PC Remote 
Operation(Serial)] is required.
To display the personal computer screen on the GOT, a system application (extended function) of [Video/RGB (Object)] or 
[Video/RGB] is required.
Configuring the following settings incorporates the applications into the package data automatically.
• [PC Remote Operation(Serial)]
Select [Destination I/F] in the [PC Remote Operation] dialog.

➟10.4.4 [PC Remote Operation] dialog
• [Video/RGB (Object)]
Select [Use Video/RGB Input] and select [GT27-R2 (RGB Screen only)] for [Unit Type Name] in the [Video/RGB Input] 
dialog.

➟10.6.5 [Video/RGB Input] dialog
• [Video/RGB]
Select [Use Video/RGB Input] and select [GT27-R2-Z (RGB Screen only)] or [GT27-V4-Z/GT27-V4R1-Z] for [Unit Type 
Name] in the [Video/RGB Input] dialog.

➟10.6.5 [Video/RGB Input] dialog

■2 Required version of BootOS
To use GT27-R2, install version N or later of BootOS on the GOT.

➟4.3.2 Transferring data

■3 Remote personal computer operation (Serial) to be set for one project
One remote personal computer operation function is available for one project.

■4 Required software to be installed
(1) Remote Personal Computer Operation Driver (DMT-DD, TSC-DD, or MES_2X)

This is a mouse emulation software for use in operating the mouse pointer on the personal computer according to the 
device data of the X-coordinate, Y-coordinate, and touch status sent by the GOT.
Select the driver according to the OS of the personal computer used.
• Windows 10, Windows 8.1, or Windows 8: DMT-DD
• Windows 7 or Windows Vista: TSC-DD
• Windows XP: MES_2X
For the details, refer to the following.

➟(3) Operating environment
The copyright of the software belongs to DMC Co., Ltd.
Use the software under the license agreement displayed when installing the software.

(2) How to obtain the software
Obtain the software with either of the following methods.
• Disk5 folder in GT Works3 DVD
The location where the software is stored is shown in the ReadmeE.txt.

• Contact your local distributor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) Operating environment
The following shows the operating environment of the personal computer and the drivers for the remote personal 
computer operation.

*1 Version 1.00.27 or later is supported.
*2 Compatible with GT Designer3 Version 1.108N or later.
*3 Microsoft .NET Framework 2.0, 3.0, or 3.5 must be installed.
*4 Compatible with GT Designer3 Version 1.200J or later.
*5 Microsoft .NET Framework 3.5 must be installed.
*6 The system builder version is not applicable.
*7 For installation, the administrator authority is required.

Item Driver Description

Model -
Personal computer that Windows runs on.
Equipped with the RS-232 serial port (9-pin).

OS (English)

DMT-DD *4*5*6*7

• Microsoft Windows 10 Enterprise (32 bit, 64 bit)
• Microsoft Windows 10 Pro (32 bit, 64 bit)
• Microsoft Windows 10 Home (32 bit, 64 bit)
• Microsoft Windows 8.1 Enterprise (32 bit, 64 bit)
• Microsoft Windows 8.1 Pro (32 bit, 64 bit)
• Microsoft Windows 8.1 (32 bit, 64 bit)
• Microsoft Windows 8 Enterprise (32 bit, 64 bit)
• Microsoft Windows 8 Pro (32 bit, 64 bit)
• Microsoft Windows 8 (32 bit, 64 bit)

TSC-DD *1*2

• Microsoft Windows 7 Ultimate (32 bit) Service Pack1
• Microsoft Windows 7 Enterprise (32 bit) Service Pack1
• Microsoft Windows 7 Professional (32 bit) Service Pack1
• Microsoft Windows 7 Home Premium (32 bit) Service Pack1
• Microsoft Windows 7 Starter (32 bit) Service Pack1
• Microsoft Windows Vista Ultimate (32 bit) Service Pack2 or later
• Microsoft Windows Vista Enterprise (32 bit) Service Pack2 or later
• Microsoft Windows Vista Business (32 bit) Service Pack2 or later
• Microsoft Windows Vista Home Premium (32 bit) Service Pack2 or later
• Microsoft Windows Vista Home Basic (32 bit) Service Pack2 or later
• Microsoft Windows XP Professional (32 bit) Service Pack3 or later *3

• Microsoft Windows XP Home Edition (32 bit) Service Pack3 or later *3

MES_2X 
• Microsoft Windows XP Professional (32 bit) Service Pack2 or later
• Microsoft Windows XP Home Edition (32 bit) Service Pack2 or later
• Microsoft Windows 2000 Professional Service Pack4 or later
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10.4.3 How to use the remote personal computer operation (Serial)

■1 System configuration
The following shows the system configuration of the personal computer.

*1 Between the personal computer and the GOT, the connecting connection cable 1 (RS-232 cable) and connection cable 2 
(analog cable) is required.

*2 The cable length depends on the specifications of the personal computer to be used.
Prepare a cable with a length suitable for the specifications of the personal computer to be used.

*3 The cable length depends on the specifications of the personal computer to be used.
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 

Version1
*4 Not available to GT2705-V.
*5 Usable for channel 1 only.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal 
computer

Connection cable*1 GOT

PLC

Number of 
connectable 
multimedia 
controllersCable model Maximum 

length Option GOT 
model

Select by 
each user

Connection cable 1:
GT01-C30R2-9S
or
Preparing connection 
cables by each user*3

15m

- (Built into GOT)

GT27*4
For the system configuration 
between the GOT and the PLC, 
refer to each connection manual.

One personal 
computer for one 
GOT

GT15-RS2-9P

Connection cable 2:
GT15-C50VG
or
Preparing connection 
cables by each user*3

*2

GT27-R2 *5

GT27-R2-Z *5

GT27-V4R1-Z

Personal 
computer GOT

Connection cable 1

Connection cable 2

PLC

The system configuration 
between GOT and PLC 
depends on the connection type.
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■2 Setting procedure
Step 1 Connect the personal computer to the GOT.

➟■1 System configuration
Step 2 Set one of the following functions to display the personal computer screen on the GOT.

• Video/RGB display object
To use the remote personal computer operation (Serial), select [PC Remote Operation (Serial)] for 
[Touch Mode] in the [Video/RGB Display] dialog.

➟8.27.2 ■2 Setting procedure
• RGB display function

➟10.7.3 ■2 Setting procedure
Step 3 Configure the settings for the remote personal computer operation (Serial) in the [PC Remote Operation] 

dialog.

➟10.4.4 [PC Remote Operation] dialog
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Install Remote Personal Computer Operation Driver (DMT-DD, TSC-DD, or MES_2X) on the personal 

computer.

➟10.4.5 Settings of Remote Personal Computer Operation Driver
Step 6 Operate the GOT.

➟10.4.6 Action of the remote personal computer operation (Serial)
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10.4.4 [PC Remote Operation] dialog

Select [Common] → [Peripheral Setting] → [PC Remote Operation] from the menu to display the setting dialog.

1) Remote personal computer operation (Ethernet)
No setting is required.

2) Remote personal computer operation (Serial)
Set the interface of the GOT.
The following shows the items to be selected.

• [Standard I/F(RS232)]
• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

Device setting
To send the touch status of the GOT screen to the personal computer, turn on the Touch Status 
Communication Control signal (GS511.b0).
For details of the Touch Status Communication Control signal (GS511.b0), refer to the following.

➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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10.4.5 Settings of Remote Personal Computer Operation Driver

■1 Before installation
Before installing Remote Personal Computer Operation Driver, check the following.

• The personal computer is properly connected to the GOT.
➟10.4.3 How to use the remote personal computer operation (Serial)

• Settings are properly made in the project.
➟10.4.4 [PC Remote Operation] dialog

■2 When using Remote Personal Computer Operation Driver (DMT-DD)
Remote Personal Computer Operation Driver calibrates the difference between the coordinates of a touch on the GOT 
screen and the coordinates of a click on the personal computer screen.
The following shows how to install and set Remote Personal Computer Operation Driver.

Step 1 Run setup.exe.
Step 2 Follow the on-screen instructions to install.
Step 3 After the message [Installation Complete] appears, click the [Close] button to exit the setup wizard.
Step 4 From the Windows start menu, select [DMC] → [DMT-DD] to display the [Touch Screen Properties] screen. 

*1

*1 How to open the start menu differs depending on the Windows version.
Check how to operate Windows.

Step 5 On the [Software Setting] tab of [Basic Setting], click the [4Point] button.
Step 6 On the GOT screen, touch the calibration point four times.

Step 7 Click the [OK] button.
Step 8 Click the [Exit] button to exit the [Touch Screen Properties] screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Calibration point
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■3 When using Remote Personal Computer Operation Driver (TSC-DD)
Remote Personal Computer Operation Driver calibrates the difference between the coordinates of a touch on the GOT 
screen and the coordinates of a click on the personal computer screen.
The following shows how to install and set Remote Personal Computer Operation Driver.

Step 1 Run Installer.exe.
Step 2 Follow the on-screen instructions to install.
Step 3 After the message [Installation Complete] appears, click the [Close] button to exit the setup wizard.
Step 4 Select [Start] → [All Programs] → [DMC] → [DMC Touch Panel Configuration] from the menu to display the 

[Touch Panel Driver Properties] screen.
Step 5 Select [5p] for [Calibration Point], and click the [Calibration] button.
Step 6 On the GOT screen, touch the calibration point five times.

Step 7 Click the [OK] button.
Step 8 On the [Touch Panel Driver Properties] screen, click the [Test] button to display the test screen in the RGB 

display area on the GOT screen.
Step 9 On the GOT screen, touch the left [Clear] button and then the right [Clear] button to check for proper 

operation.

Step 10 On the GOT screen, touch the left [End] button and then the right [End] button to exit the test screen.
Step 11 Click the [Close] button to exit the [Touch Panel Driver Properties] screen.

Calibration point

Clear

End

Clear

End

[Clear] button
[End] button
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■4 When using Remote Personal Computer Operation Driver (MES_2X)
Remote Personal Computer Operation Driver calibrates the difference between the coordinates of a touch on the GOT 
screen and the coordinates of a click on the personal computer screen.
The following shows how to install and set Remote Personal Computer Operation Driver.

Step 1 Run Install.exe.
Step 2 Configure the settings as shown below, and follow the on-screen instructions to install.

• On the [MES_2X Driver Select] screen, select [RS232C] and a communication port.
• On the [MES_2X Driver EEPROM] screen, select [DO NOT USE].

Step 3 After the message [Installation Complete] appears, click the [Close] button to exit the setup wizard.
Step 4 Select [Start] → [All Programs] → [Touch Panel Driver MES_2X] → [TP Control] from the menu to display 

the setting screen.
Step 5 Select [5p] for [Calibration Point], and click the [Calibration] button.
Step 6 On the GOT screen, touch the calibration point five times.

Step 7 Click the [OK] button.
Step 8 On the [Touch Panel Driver Properties] screen, click the [Test] button to display the test screen in the RGB 

display area on the GOT screen.
Step 9 On the GOT screen, touch the left [Clear] button and then the right [Clear] button to check for proper 

operation.

Step 10 On the GOT screen, touch the left [End] button and then the right [End] button to exit the test screen.
Step 11 Click the [OK] button to exit the [Touch Panel Driver Properties] screen.

Calibration point

Clear

End

Clear

End

[Clear] button
[End] button
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10.4.6 Action of the remote personal computer operation (Serial)

■1 Action of the GOT with the RGB display
When the GOT displays the personal computer screen using the RGB display, turning on the Touch Status Communication 
Control signal (GS511.b0) of the touch status communication control function sends the data in the touch status external 
notification function (X-coordinate (GS654), Y-coordinate (GS655), touch status (GS656)) to the personal computer.
The following shows the action according to the touch status.
For the GOT internal devices, refer to the following.

➟12.1.3 GOT special register (GS)

■2 Action of the mouse pointer
The following explains the action of the mouse pointer according to the touch status.

(1) Touching the GOT screen
When the GOT screen is touched while the Touch Status Communication Control signal is on, the data in the touch status 
external notification function (X-coordinate (GS654), Y-coordinate (GS655)) is sent to the personal computer and the 
mouse pointer moves to the corresponding position.
The device value 1 is sent to the personal computer as the touch status (GS656) in the touch status external notification 
function while the GOT is touched.
As a result, the mouse pointer moves on the personal computer screen.

(2) Stopping the touch operation on the GOT
When the touch operation is stopped while the Touch Status Communication Control signal is on, the device value 0 is 
sent to the personal computer only one time as the touch status (GS656) in the touch status external notification function.
As a result, the mouse pointer clicks the personal computer screen one time.

(3) Turning off the Touch Status Communication Control signal during the GOT screen touch
When the Touch Status Communication Control signal turns off during the GOT screen touch due to cable disconnection, 
GOT power disconnection, and others, the touch status external notification function (X-coordinate (GS654), Y-
coordinate (GS655)) holds the values right before the signal turns off.
The device value 0 is sent to the personal computer only one time as the touch status (GS656) in the touch status external 
notification function while the GOT is touched.
As a result, the mouse pointer clicks the personal computer screen one time.
The following shows the action timing.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Touch Status Communication Control signal: 
(GS511.0) = ON

Touch status external notification function

X-coordinate = 391, Y-coordinate = 301, Touch status =1

RGB display function

Touch status external notification device (X-coordinate): (GS654) = 391
Touch status external notification device (Y-coordinate): (GS655) = 301
Touch status external notification device (touch status): (GS656) = 1
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10.4.7 Precautions

This section explains the precautions for using the remote personal computer operation (Serial).

■1 Precautions for installation
(1) TSC-DD-compatible mode

If Remote Personal Computer Operation Driver (DMT-DD) is installed successfully, TSC-DD-compatible mode is enabled 
and the title bar of the [Touch Screen Properties] screen displays [Touch Screen Properties [TSC-DD] Mode].
Otherwise, the installation may have failed.
Reinstall the driver with administrator privileges.

■2 Precautions for use
(1) Drag operation

As a drag operation on the GOT screen is performed, the touch status data is not correctly sent to the personal computer, 
the mouse pointer operation may stop.
For the remote personal computer operation (Serial), do not perform the drag operation.

(2) USB mouse and keyboard function
The USB keyboard is not available for the remote personal computer operation (Serial) .
The left button is only available for the USB mouse.
For details on the USB mouse and keyboard function, refer to the following.

➟5.3.4 Configuring the settings for a mouse and a keyboard used with the GOT ([USB Host])

(3) Precautions for the video/RGB display object
For the precautions for the video/RGB display object, refer to the following.

➟8.27.3 Precautions for a video/RGB display object

(4) Precautions for RGB display function
For the precautions for the RGB display function, refer to the following.

➟10.7.6 Precautions

Touch operation (operator)

X-coordinate (GS654)

Y-coordinate (GS655)

Touch status (GS656)

Touch Status Communication 
Control signal: (GS511.0)

X-coordinate (GS654)

Y-coordinate (GS655)

Touch status (GS656)

391 199

301 263

263

0

0

199

Touch status external 
notification function

Touch status communication 
control function

Touch status external 
notification function

(Holding the coordinates of Touch 1) (Holding the coordinates of Touch 2)

(Output for Touch 1) (Output for Touch 2)

Touch 1 X: 
391,  Y: 301

Touch 2 X: 
199,  Y: 263

(ON)

(Output for Touch 2)

(Holding the coordinates of Touch2)

(OFF)

(No output for Touch 1)

(Not outputting the coordinates of Touch 1)

1 10 0

1 0

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.4.8 Relevant settings

Set the relevant settings other than the specific settings for the remote personal computer operation (Serial) as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
➟12.1.3 GOT special register (GS)

(1) Action at a simultaneous 2-point press
When two points are touched simultaneously on the GOT, or when one point on the GOT is touched and the GOT remote 
screen is clicked simultaneously by the remote personal computer operation, the devices of GS654, GS655, and GS656 
notify the GOT as the priority below.
If some screens have the same priority, the devices of GS654, GS655, and GS656 notify the GOT of the screen which 
is placed on the leftmost and uppermost position in priority to the other screens.
(The left position has higher priority than the upper position.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Controlling whether to send or not the touch status to the personal computer. (Read 
device) GS511.b0

Notifying the position touched (X-coordinate, Y-coordinate) on the GOT. (Write device) GS654,GS655

Notifying whether the screen is touched or not. (Write device) GS656

Screen Priority

Popup window screen High

Low

Comment window screen

Key window

Video window

Overlap window 5 screen (area of a touchable object)

Overlap window 5 screen (area out of a touchable object)

Overlap window 4 screen (area of a touchable object)

Overlap window 4 screen (area out of a touchable object)

Overlap window 3 screen (area of a touchable object)

Overlap window 3 screen (area out of a touchable object)

Overlap window 2 screen (area of a touchable object)

Overlap window 2 screen (area out of a touchable object)

Overlap window 1 screen (area of a touchable object)

Overlap window 1 screen (area out of a touchable object)

Base screen (area of a touchable object)

Base screen (area out of a touchable object)
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10.5 Viewing the GOT from a Personal Computer (VNC Server Function)

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

10.5.1 Overview of the VNC server function

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
The VNC server function enables you to remotely operate the GOT from the personal computer at a distant location via 
Ethernet by using Virtual Network Computing (VNC).

10.5.2 Specifications of the VNC server function

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

■1 System application (extended function)
To use the VNC server function, a system application (extended function) of [VNC Server] is required.
Selecting [Use VNC Server] in the [VNC Server] dialog incorporates the application into the package data automatically.

➟10.5.4 [VNC Server] dialog

■2 Number of VNC server function settings for one project
One VNC server function setting is available for one project.

■3 Specifications of VNC server and VNC client
The GOT and the personal computer are used as a VNC server and a VNC client, respectively.
• VNC server
The VNC server is the GOT that is remotely operated from the personal computer by using this function.

➟10.5.5 ■3 Remote screen
• VNC client
The VNC client is the personal computer or other equipment that is used to remotely operate the GOT by using this 
function.
VNC client software must be installed on the personal computer.
For the installation instructions, refer to the following.

➟10.5.5 Personal computer setting

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT (VNC server)

Personal computer (VNC client)

GOT screen

Mouse/keyboard 
operation

The GOT operates according 
to the operation on 
the personal computer.

Operating the GOT screen displayed 
on the remote screen

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 License number registration
To use the VNC server function, register a license number on the GOT.
For how to register the license number, refer to the following.

➟GOT2000 Series User's Manual (Utility)
When the license number is not registered, the 30 minutes of trial for the function is available upon connection to the VNC 
server.
Up to 30 trials are available.
To start a trail again, turn off and then on the GOT.
After 30 trials, you must register the license number to use the function.

■5 Required software for the equipment that is used to remotely operate the GOT
When the GOT is used as the VNC server, the VNC client software must be installed on the equipment that is used to 
remotely operate the GOT.
Install the either of the following VNC client software according to the equipment that is used to remotely operate the GOT.

(1) For personal computer
• Applicable VNC client software

• Operating environment
For the operating environment of the software, refer to the following website.

➟http://www.uvnc.com/

(2) For smartphone or tablet
• Applicable VNC client software

For the VNC client software whose operations have been validated, refer to the following Technical News.
➟VNC client software that can be used with the GOT2000 series VNC server function (GOT-A-0069)

• Operating environment
The operating environment depends on the smartphone or tablet you use.
Refer to the website of the smartphone or tablet.

• How to obtain the software
How to obtain the software depends on the software which is applicable to the smartphone or tablet you use.

(1) Precautions for using the VNC client software
The VNC client software may not operate properly depending on the OS on a smartphone or tablet, VNC 
client software version, and usage environment. Before using the software, fully validate its operations 
in a usage environment.

Name Manufacturer Version

UltraVNC (32 bit) UltraVNC team 1.3.8.1, 1.1.9.6, 1.0.9.6.2, 1.0.8.2 recommended
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■6 Authorization control
Enabling the authorization control disables the simultaneous operation from the personal computer and the GOT.
To enable the authorization control, select [Restrict simultaneous operations of PC and GOT] in the [VNC Server] dialog.

➟10.5.4 [VNC Server] dialog

(1) Obtaining the authorization
Enabling the authorization control allows you to operate the GOT on only the equipment (personal computer or GOT) that 
holds the authorization.
The equipment, whose popup display is clicked or touched when the authorization guarantee time is 0, obtains the 
authorization.
Once the personal computer or the GOT obtains the authorization, the authorized equipment holds the authorization until 
the authorization guarantee time is passed.
While the personal computer holds the authorization, [The remote device (###.###.###.###) is now in operation.] and 
[Wait time to obtain operating authority: ****s)] are alternately displayed on the screens of both equipment.
While the GOT holds the authorization, [The GOT is now in operation.] and [Wait time to obtain operating authority: ****s] 
are alternately displayed on the screens of both equipment.
###.###.###.### indicates the IP address of the personal computer as the VNC client.
The asterisks **** indicate the authorization guarantee time (second).
Set the authorization guarantee time on the GOT utility.
For how to set the authorization guarantee time on the GOT utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(2) Controlling the authorization among pieces of equipment
To control the authorization among pieces of equipment, use the VNC server function in combination with the GOT 
network interaction function.

The following shows the differences when the two functions are used in combination.
• To perform operations on the VNC server or VNC client, the authorization of both the VNC server function and the GOT 
network interaction funciton is required.

• The setting of [Guaranteed time of operational authority after the last operation] in the [GOT Setup] window becomes 

The remote device is now in operation.

A 1254

B 348

A 1254

B 348

Example: When the personal computer holds the authorization

The remote device (192.168.3.10) is now in operation. 
Wait time to obtain operating authority: ****s  

Personal computer 
(VNC client) 
(IP Address: 192.168.3.10)  

Ethernet

GOT (VNC server)

Operating the GOT 
(VNC server) is prohibited.

Remotely operating the GOT on 
the personal computer (VNC client).

Personal computer 
(VNC client)

GOT2
(VNC server)

Authorization control scope of the GOT 
network interaction function

Authorization control scope of 
the VNC server function

GOT1
(Master GOT)

GT SoftGOT2000

The authorization control of 
both the VNC server function 
and the GOT network 
interaction function is enabled.

Ethernet
PLC
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invalid. The authorization guarantee time set in the [GOT Network Interaction] dialog becomes valid.
• The popup display of the GOT network interaction function is applied to the VNC server or VNC client screen.
For the details of the GOT network interaction function, refer to the following.

➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])

(3) How to identify the authorized equipment
Check the GOT internal device to identify the authorized equipment. (Authorized Equipment Notification signal, 
GS1230.b2)

➟10.5.7 ■1 GOT Internal Device

(4) Operation status popup notification function
This function notifies, with a popup display, the authorized equipment and the waiting time for the unauthorized 
equipment to obtain the authorization.
The display position of the operation status popup display is the same as that of the alarm popup display.
(To set the display position, select [Display alarms as popups] in the [Screen Property] dialog.)
The operation status popup display appears on the bottom, center, or top of the screen.
When the base screen is switched while the operation status popup display is performed, the operation status popup 
display appears at the display position of the alarm popup display which is set for the destination base screen.
Each touch of the leftmost portion of the operation status popup display switches its display position to the top, center,or 
bottom, in that order.

Configure the display setting on the GOT utility or GT Designer3.
For how to configure the display setting on the GOT utility, refer to the following.

➟GOT2000 Series User's Manual (Utility)
For how to configure the setting on GT Designer3, refer to the following.

➟2.7.1 ■1 [Basic] tab

■7 Differences between the functions to remotely operate the GOT
When the GOT is connected to equipment such as a personal computer by Ethernet, you can operate the GOT from the 
equipment by using the following functions.
• SoftGOT-GOT link function
• VNC server function
• GOT Mobile function

The following shows the differences between these functions.

A 1254

B 348

A 1254

B 348

The remote device is now in operation.

A 1254

B 348

A 1254

B 348

The remote device is now in operation.A 1254

B 348

A 1254

B 348

The remote device is now in operation.

Displayed on bottom of the screen Displayed on top of the screen Displayed on center of the screen

Display 
position 
switching

Display 
position 
switching

Display position switching

Touch the leftmost 
of the display area!

Touch the leftmost 
of the display area!

Touch the leftmost 
of the display area!

Item
Function

SoftGOT-GOT link function VNC server function GOT Mobile function

Equipment Personal computer or PC CPU module 
on which GT SoftGOT2000 is installed

Information device (such as a tablet and 
personal computer) on which an 
applicable VNC client is installed

Information device (such as a tablet and 
personal computer) on which an 
applicable browser is installed

Number of modules or clients 
connectable to one GOT

One GT SoftGOT2000 module is 
connectable.
Up to seven GT SoftGOT2000 modules 
are connectable when the GOT network 
interaction function is enabled.

One VNC client is connectable.
When one browser is one client.
GOT: 5 clients
GT SoftGOT2000: 15 clients

Required number of licenses One license key is required for one 
personal computer. One license is required for one GOT. One license is required for one GOT.

Screen display contents The GOT and a GT SoftGOT2000 
module can display different contents.

The GOT and the remote screen on the 
personal computer display the same 
contents.

The GOT and each client display 
different contents. (The client displays 
the dedicated mobile screens.)
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The following shows the details and references of each function.

(1) VNC server function
With the VNC server function, the remote screen of the personal computer displays the GOT screen.
You can view the data collected by the GOT, including alarm data and logging data, on the personal computer in real time.
Even while an extended function is used, you can also remotely operate the GOT from the personal computer.

Since the VNC server function increases the processing load on the GOT, the GOT may delay displaying a screen or 
collecting data, including alarm data and logging data.
The GOT may also delay responding to an operation from the VNC client (personal computer).
Set the load balance between processing of the VNC server function and processing of the other functions in the GOT 
as necessary.
The processing load balance can be set in the [VNC Server] dialog or using GS1798.

➟10.5.2 Specifications of the VNC server function
10.5.7 Relevant settings

Screen targeted for the 
exclusive authorization control All screens All screens

Screen in which the exclusive 
authorization control is enabled (This 
control can be enabled for each screen.)

Creation of dedicated screens 
(project data setting) Not needed Not needed Mobile screens must be created.

Storage location of project data

The GOT and a GT SoftGOT2000 
module each store project data. (The 
GT SoftGOT2000 module reads project 
data from the GOT.)

Only the GOT stores project data. The GOT or GT SoftGOT2000 stores 
project data.

Storage location of resource 
data

When a GT SoftGOT2000 module 
reads project data from the GOT, the 
module also reads resource data.
Accordingly, the GOT and the GT 
SoftGOT2000 module each store the 
resource data.

Only the GOT stores resource data. The GOT or GT SoftGOT2000 stores 
project data.

Availability of extended 
functions for equipment

Limited
➟GT SoftGOT2000 Version1 

Operating Manual
Not limited

Limited
➟(a) Screen security (level 

authentication and operator 
authentication)

Item
Function

SoftGOT-GOT link function VNC server function GOT Mobile function

Monitoring Remote operation

GOT screen display

Ethernet

PLC

The remote device is now in operation. (10s)

A 1254

B 348

A 1254

B 348

GOT 
(VNC server)

Personal computer 
(VNC client)

Remotely operating the GOT on 
the personal computer (VNC client) 
(The personal computer does not monitor 
the PLC.)
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(2) SoftGOT-GOT link function
With the SoftGOT-GOT link function, GT SoftGOT2000 and the GOT each have the project data and monitor the 
controller.
Since GT SoftGOT2000 displays the GOT screen on the personal computer, the processing load on the GOT is reduced.
By using a GOT internal device for the screen switching device, GT SoftGOT2000 and the GOT can display different 
screens.

The GOT and GT SoftGOT2000 each operate independently, which may cause the difference in the collected data 
including the alarm data and logging data between the GOT and the personal computer.
The extended functions which are unavailable for GT SoftGOT2000 cannot be used with the SoftGOT-GOT link function.
For the details of the SoftGOT-GOT link function, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(3) GOT Mobile function
The GOT Mobile function allows an information device, such as a tablet, to display the mobile screens stored in the server 
(GOT).
One browser is handled as one client to access the GOT, and up to five clients (GOTs) and up to 15 clients (GT 
SoftGOT2000 modules) can make access simultaneously.
Each client can display different mobile screens.
The information device does not store project data and resource data, and the server (GOT) stores the data for 
management.

You cannot use the functions that are incompatible with the GOT Mobile function, such as objects incapable of being 
placed on mobile screens.
For the details of the GOT Mobile function, refer to the following.

➟10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)

The remote device is now in operation. (10s)

A 1254

B 348

A 1254

B 348

Monitoring

The personal computer reads 
the project data and the resource 
data from the GOT.

Ethernet

PLC

Monitoring

The personal computer (GT SoftGOT2000) 
and the GOT monitor the PLC independently.

GOT Personal computer 
(GT SoftGOT2000)

A 1254

B 348

A 1254

B 348

Tablet

Mobile screen 1

Line A 258

Mobile screen 2

Products
Line A

Line B
558

197

Ethernet

PLC
GOT

(Server)

Personal computer Client 1

Accessing the mobile screen

Accessing the mobile screen

Client 2

Monitoring
10 - 74 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.5 Viewing the GOT from a Personal Computer (VNC Server Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
■8 Authorization control when the SoftGOT-GOT link function is used
When the GOT network interaction function is not used, the VNC server function and the SoftGOT-GOT link function control 
the authorization independently of each other.
(The authorization control of the SoftGOT-GOT link function is always enabled.)
The following shows the authorization control when the VNC server function and the SoftGOT-GOT link function are used 
in combination.

○: Available ×: Not available

Authorization control 
setting of the VNC 

server function
Authorized equipment

Operating the GOT

From GOT From VNC client From GT SoftGOT2000

Enabled

GOT (VNC server) ○ × ×

Personal computer
(VNC client) × ○ ×

Personal computer
(GT SoftGOT2000) × × ○

Disabled

GOT (VNC server) ○ ○ ×

Personal computer
(VNC client) ○ ○ ×

Personal computer
(GT SoftGOT2000) × × ○

リモート側が操作中(10s)
A 1254

B 348

A 1254

B 348

Ethernet

PLC

Operation using 
the SoftGOT-GOT 
link function

GOT
Personal computer
(GT SoftGOT2000)

Personal computer 
(VNC client)

Operation using 
the VNC server function
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10.5.3 How to use the VNC server function

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

■1 System configuration
The following shows the system configuration of the personal computer.

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 for a cascade connection (within 500 m)
• 100BASE-TX: Up to 2 for a cascade connection (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Not available to GT2505-V and GT25HS-V.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer
(VNC client)

Connection cable *1*2,
wireless LAN access point

Maximum 
segment 
length *3

GOT
(VNC server)

PLC

Number of 
connectable 

personal 
computersOption GOT 

model

Select by each user

• 10BASE-T
Shielded twisted pair cable (STP) or 
unshielded twisted pair cable (UTP): 
Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): 
Category 5 and 5e

100m

- (Built into GOT)

GT27
GT25
GT21
GS25
GS21

For the system 
configuration 
between the 
GOT and the 
PLC, refer to 
each connection 
manual.

One personal 
computer for 
one GOT

GT25-J71E71-100
GT27

GT25 *6

- - GT25-WLAN
GT27 *4

GT25 *4*6

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN 
access points and system devices, 
refer to the following Technical News.
➟List of Valid Devices Applicable for 

GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-
0160)

- GT25-WLAN
GT27 *5

GT25 *5*6

GS25 *5

PLC
Personal computer 

(VNC client)

The system configuration between GOT and PLC 
depends on the connection type.

GOT 
(VNC server)

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
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10
■2 Setting procedure
The following shows how to configure the settings for the VNC server function.

Step 1 Connect the personal computer to the GOT.

➟■1 System configuration
Step 2 Configure the settings for the VNC server function in the [VNC Server] dialog.

➟10.5.4 [VNC Server] dialog
Step 3 Set the GOT Ethernet interface.

➟5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])
Step 4 To control the authorization among pieces of equipment on a network, set the GOT network interaction 

function.

➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])
Step 5 Write the package data to the GOT.

Make sure to set [GOT IP Address] and [Peripheral S/W Communication Port No.] for the GOT in the 
[Communication Configuration] dialog.

➟4.8.8 [Communication Configuration] dialog
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 6 Register the license number on the GOT.

For how to register the license number, refer to the following.
➟GOT2000 Series User's Manual (Utility)

Step 7 Install the VNC client software on the personal computer or others, and configure the setting.
After the setting is completed, operate the GOT on the remote screen.

➟10.5.5 Personal computer setting
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10.5.4 [VNC Server] dialog

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Select [Common] → [Peripheral Setting] → [VNC Server] from the menu to display the setting dialog.

1) [Use VNC Server]
Select this item to enable the VNC server function.

2) [Server Connection Setting]
Configure the GOT connection settings.

3) [Connecting Password]
Up to 31 characters can be set for a connecting password.
Note that only the first eight characters are used for the password verification. The other characters are not used for 
the verification.
To use the multiple passwords, set the passwords so that the first eight characters are different.
One-byte alphanumeric characters, one-byte space, and the following symbols are available for the password. ! " # $ 
% & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~

Item Description

[Port No.]

Set the port number for the GOT to communicate with a VNC client.
The setting range is [1024] to [65534].
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

Item Description

[Operation/Monitoring password] Set the password to remotely operate and display the GOT on the personal computer.

[Use exclusive password for monitoring] Select this item to only remotely display the GOT on the personal computer.

[Exclusive password for monitoring] Set the password to only remotely display the GOT on the personal computer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
5)
6)
7)
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4) [GOT processing balance when VNC server is in operation]
Set the GOT load balance between the VNC server function processing and the other processing (including displaying 
the screens, and collecting the alarm data and logging data).

• [Standard]
Select this item to set the standard balance for the balance between the VNC server function processing and the 
other processing.

• [VNC Server Priority]:
Assigns a higher priority to the VNC server function processing.
The update rate of the remote screen increases.
Select this item when the amount of the other processing is small.
When the number of monitoring objects is large or the background processing (including the alarm function and 
logging function) is performed, the delay in GOT behavior may be caused.
Consider the number of monitoring objects, alarm function settings, logging function settings, and others, and then 
set the GOT processing load balance.

• [GOT Monitoring Priority]:
Assigns a higher priority to the other processing.
The number of the other processing delays caused by the VNC server function decreases.
Select this item when the amount of the other processing is large.

5) [Restrict simultaneous operations of PC and GOT]
Select this item to disable the simultaneous operation from the GOT and the remote screen of the personal computer.
Selecting the item enables the authorization control.

➟10.5.2 ■6 Authorization control
6) [Display video/multimedia]

Available to GT27 models excluding GT2705-V.
Set whether to display a video image displayed on the GOT on the remote screen of the personal computer.
Select this item to display the video image displayed on the GOT on the remote screen of the personal computer.
Deselect this item not to display the video image displayed on the GOT on the remote screen of the personal computer.
The display area of the video image displays the object, figure, or others that is placed behind the video image.
When the remote screen of the personal computer displays the video image displayed on the GOT, the update rate of 
the remote screen decreases.

7) [Reset the security level or re-authenticate the operator at the time of VNC server connection]
Resets the security level or performs a forced logout of the GOT at the time of connection between the GOT (VNC 
server) and the VNC client.
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10.5.5 Personal computer setting

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

■1 How to install the UltraVNC
Step 1 Download the Win32 Full version of UltraVNC (English only) from the following website.

http://www.uvnc.com/
Note that the above website may be changed without notification.

Step 2 Execute the downloaded file, and start the installer.
Step 3 The setup window appears.

Click the [Next] button until the [License Agreement] screen is displayed.
Confirm the description in the screen, and then select [I accept the agreement].

Step 4 Click the [Next] button until the [Select Destination Location] screen is displayed.
In the screen, select the location where the software is installed.

Step 5 The [Select Components] screen appears.
Select [Full installation] or [UltraVNC Viewer Only], and click the [Next] button.

Step 6 The [Select Start Menu Folder] screen appears.
Select the start menu folder to create a shortcut, and click the [Next] button..

Step 7 The confirmation window appears to confirm whether to download the following software. (Not displayed 
when [UltraVNC Viewer Only] is selected in the [Select Components] screen)

• Optional non-GPL addons recommended for Vista
Download this software only when you use Windows Vista.

• Optional non-GPL Mirror Driver
Make sure to download this software.

Step 8 The [Select Additional Tasks] screen appears.
• To create the shortcut icon on the desktop, enable [Create UltraVNC desktop icons].
• To open the file with the extension of .vnc by using UltraVNC Viewer, select [Associate UltraVNC Viewer 

with the .vnc file extension].
When [Full installation] is selected in the [Select Components] screen, setting items other than the above 
are also displayed.
Since the additional setting items depend on the personal computer you use, configure the settings as 
required.

Step 9 The confirmation screen for installation appears.
Confirm the description in the screen, and then click the [Install] button.
Installation of UltraVNC starts.

■2 Settings
After UltraVNC Viewer is started, set the GOT IP address.

➟■3 Remote screen

(1) Using the GOT as a VNC client
With the remote personal computer operation (Ethernet), the GOT as the VNC client can be connected 
to the VNC server.
For the setting of the remote personal computer operation (Ethernet), refer to the following.
➟10.3 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation 
(Ethernet))

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Remote screen
The remote screen of the personal computer is used to display and operate the GOT screen.

(1) How to display the remote screen
Display the remote screen by using the VNC client software installed on the personal computer.

Step 1 Select [UltraVNC] → [UltraVNC Viewer] from the start menu to start UltraVNC Viewer.
Step 2 In the setting dialog, set the GOT IP address in the [VNC Server] field and click the [Connect] button.

Step 3 Enter the password,which is set in the [VNC Server] dialog, in the [Password] field, and click the [Log On] 
button.

Step 4 The remote screen appears.
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(a) When the remote screen does not display the GOT screen
Even though the VNC client is connected to the VNC server by using the VNC client software, if the remote screen does 
not display the GOT screen, make sure to configure the setting as shown below.
Start UltraVNC Viewer, and click the [Options] button.
The [Connection Options] window appears.

Check that [Full Colors] is selected in [Format and Encoding].
When [Full Colors] is not selected, deselect [Auto select best settings] and select [Full Colors].

(b) Compression format of the transferred image
The VNC server function supports the following image compression formats.
Select the image compression format in [Format and Encoding].
Usually select [Hextile].

• Raw
• Hextile
• ZRLE

ZRLE provides a high compression rate for the images with many repeated patterns.
However, for the images with few repeated patterns, such as photos, ZRLE provides a low compression rate and a high 
processing load.
Select the image compression format according to the communication speed and the transferred screen layout.

(2) Operating procedure
Clicking the remote screen of the personal computer is recognized as touching the corresponding position on the GOT.
The keyboard operation on the remote screen of the personal computer is also recognized as the key input on the GOT.
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10.5.6 Precautions

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.

■1 Precautions for drawing
(1) Password setting

If the operation/monitoring password and the exclusive password for monitoring are the same, the password is valid as 
the operation/monitoring password.

(2) Restrictions for the operation status popup display
When the GOT uses the operation status popup display of the VNC server function, the alarm popup display cannot be 
used.
When the SoftGOT-GOT link function and the VNC server function are simultaneously used, the GOT uses the operation 
status popup display of the VNC server function and GT SoftGOT2000 uses that of the SoftGOT-GOT link function, 
respectively.

(3) GOT internal device setting
When placing the touch switch that turns on the VNC Client Communication Control signal (GS1792.b0) or the VNC Client 
Operation Control signal (GS1792.b1) on the screen, set the touch switch not to be operated from the personal computer.
(Example: Set the trigger condition so that the touch switch is disabled while the GOT communicates with the personal 
computer.)
If the signals are turned on while the GOT communicates with the personal computer, the following status is caused.
• When the VNC Client Communication Control signal is turned on
The communication with the personal computer is disconnected, and the GOT cannot communicate with the personal 
computer until the signal is turned off on the GOT.

• When the VNC Client Operation Control signal is turned on
Though the communication with the personal computer is not disconnected, the personal computer cannot remotely 
operate the GOT.

For the GOT internal devices, refer to the following.
➟10.5.7 ■1 GOT Internal Device

(4) RGB screen display
The RGB screen cannot be displayed on the remote screen of the personal computer.
To use the RGB display function, configure the settings, such as arranging a touch switch for returning to another object. 
Do not create a screen for displaying the RGB screen only.
(For example, a screen on which the RGB screen and a touch switch having no shape are arranged)
In such a case, no content is displayed on the remote screen.
To avoid no contents displayed on the remote screen, configure the settings, such as arranging the RGB screen together 
with an object having a shape.

■2 Precautions for use
(1) Authorization control setting

Without the authorization control setting, do not operate the GOT and the remote screen of the personal computer 
simultaneously.
Doing so causes a malfunction, resulting in an accident.

(2) Use of USB mouse
Even while the USB mouse is used on the GOT with the USB mouse/keyboard function, the mouse cursor is not displayed 
on the remote screen of the personal computer.

(3) Setting the load balance
Although processing of the VNC server function is prioritized, the processing speed of the function may not change.
In this case, disconnect and reconnect the communication with the personal computer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.5.7 Relevant settings

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Set the relevant settings other than the specific settings for the VNC server function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
➟12.1.3 GOT special register (GS)

(1) VNC Server Function Control (GS1792)

(2) VNC Server Operation Status Notification (GS1230)

(3) Communicating VNC Client Information Notification (GS1231 to GS1232)
The IP address of the communicating VNC client is stored in hexadecimal.
0 is stored when the VNC client does not communicate with the VNC server.
Example) When the IP address of the VNC client is 192.168.3.10, the devices of GS1231 to GS1232 store C0.A8.03.0A.
The IP address is stored as shown below.

(4) VNC Server Authorization Guarantee Status Notification (GS1233)
This device notifies the remaining authorization guarantee time (second).
When the device stores 0, the unauthorized equipment can obtain the authorization.
When the authorization control is set to [Disabled], the device stores 0.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Bit number Signal name Description

b0 VNC Client Communication Control signal
Enables/disables the communication from the VNC client.
• 0: Communication from the VNC client enabled
• 1: Communication from the VNC client disabled

b1 VNC Client Operation Control signal
Enables/disables the operation from the VNC client.
• 0: Operation from the VNC client enabled
• 1: Operation from the VNC client disabled

b2 to b7 Use prohibited -

b8 Authorization Guarantee Time Cancel signal

Cancels the authorization guarantee time setting of the equipment which last 
operated the GOT, and enables the other equipment to operate.
• 0: Authorization guarantee time valid
• 1: Authorization guarantee time invalid

b9 to b15 Use prohibited -

Bit number Signal name Description

b0 VNC Client Communication Status Notification 
signal

Notifies the communication status of the VNC client.
• 0: VNC client communication suspended
• 1: VNC client communication in operation

b1 VNC Client Operation Mode Notification signal
Notifies the operation mode of the VNC client.
• 0: Only remote display enabled
• 1: Remote display and operation enabled

b2 Authorized Equipment Notification signal
Notifies the equipment that holds the authorization.
• 0: VNC server authorized
• 1: VNC client authorized

b3 to b14 Use prohibited -

b15 VNC Server Authorized Notification signal
Notifies the equipment that holds the authorization.
• 0: VNC server authorized
• 1: VNC client authorized

GS1231

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1232

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

IP address of VNC client: C0. A8. 03. 0A (Hexadecimal)
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(5) VNC Server GOT Processing Balance Control (GS1798)
Not available to GT21 and GS21.
Set the load balance between processing of the VNC server function and processing of the other functions in the GOT, 
whether or not the GOT is connected with the VNC client.
When multiple bits are turned on, the bit having the smallest number is prioritized.
When all the bits are off, the GOT operates according to the setting of [GOT processing balance when VNC server is in 
operation].

➟10.5.4 [VNC Server] dialog
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10.6 Displaying an Image Taken by a Video Camera on the GOT (Video 
Display Function)

Not available to GT2705-V.

10.6.1 Overview of the video display function

Not available to GT2705-V.
The video display function displays video images taken by a video camera on the video window.
As the video window operates independently of other screens, the base screen can be switched while leaving the video 
window open.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

A 1254

348B

Video window 4
Video window 3
Video window 2
Video window 1

Video camera 
(Channel No.1)

Video camera 
(Channel No.2)

Video camera 
(Channel No.3)

Video camera 
(Channel No.4)
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10.6.2 Specifications of the video display function

Not available to GT2705-V.

■1 System application (extended function)
To use the video display function, a system application (extended function) of [Video/RGB] is required.
To incorporate the application into the package data automatically, select [Use Video/RGB Input] and select [GT27-V4-Z/
GT27-V4R1-Z] for [Unit Type Name] in the [Video/RGB Input] dialog.

➟10.6.5 [Video/RGB Input] dialog

■2 Number of video display function settings for one project
One video display function is available for one project.

■3 Specifications of the video display
For the video display function, the full mode and clip mode are provided.
For the details of each display mode, refer to the following.

➟10.6.4 ■5 Displaying in the full mode
　 10.6.4 ■6 Displaying in the clip mode

The following shows the differences between the full mode and clip mode.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Full mode Clip mode

Overview Displays the total image. Displays a part of the image in its original size.

Video window resolution 640×480, 720×480, 768×576 (dots) 64×64 to 768×576(dots)

Display size change 100%, 50%, or 25% of the original size Unchangeable (fixed at 100%)

Number of screens 4 1 (video window 1 only)
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10.6.3 Basic use of the video display function

Not available to GT2705-V.
The video display function enables various types of displays by using the [Video/RGB Input Common] device.
For the details of the settings, refer to the following.

➟10.6.4 Applicative use of the video display function

■1 System configuration
The following shows the system configuration of the video display function.

*1 For the types of the connectable video camera, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
*2 Select the vision sensor by each user.
*3 Cable length depends on the specifications of video equipment you use.
*4 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*5 Not available to GT2705-V.

■2 Setting procedure
Step 1 Connect the GOT and video equipment.

➟■1 System configuration
Step 2 Select [Common] → [Peripheral Setting] → [Video/RGB Input] from the menu to display the [Video/RGB 

Input] dialog.

➟10.6.5 [Video/RGB Input] dialog
Step 3 In the [Video/RGB Input] dialog, set the items as shown below and click the [OK] button.

• [Destination I/F]: [Extend I/F(1st)]
• [Use Video/RGB Input]: Selected
• [Unit Type Name]: [GT27-V4-Z/GT27-V4R1-Z]
• [Video Window]: The number of video windows used (1 to 4)
• [First Device]: Device to control the video display function

Step 4 Write the package data to the GOT.
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Display the video image on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Signal type Video equipment Connection 
cable*3

GOT Number of 
connectable video 

equipmentOption GOT model

NTSC, PAL
Video equipment, such as a video camera*1 and 
vision sensor*2, from which images can be output 
by NTSC or PAL system.

Preparing 
connection 
cables by each 
user*4

GT27-V4-Z GT27-
V4R1-Z GT27*5

Four sets of video 
equipment for one 
GOT

Video equipment such as video camera, 
vision sensor, and others GOT

Connection cable
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10.6.4 Applicative use of the video display function

Not available to GT2705-V.
The following shows the setting for applicative display by using the video display function.

■1 Displaying the video window
Video windows are displayed when any numbers of 1 to 4 are stored in the video window-channel No. devices.
(The video window does not have the close button)
The [Video/RGB Input Common] device controls the full and clip mode, the transparent processing, and others.
Size and position of the video window can be controlled according to the values set at the corresponding devices (video 
window-size device, video window-X and Y coordinates devices).
Example) Displaying the image of channel number 1 on the video window 1

■2 Display position of the video window
The video window is placed on the base screen or overlap window 1.
The position of the video window can be specified within the range indicated below.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting on GT Designer3

Operation

Video window 1 is displayed according 
to the setting for channel No., size, 
X and Y coordinates.

D106
D107
D108
D109

0→1
0→0
0→32
0→32

(Channel No.)
(Display size: 640×480)
(X-coordinate)
(Y-coordinate)

A

B

Specify the top-left position of 
video window as the display 
position.

Video window

B (dots)A (dots)Screen typeModel

GT2712-S, 
GT2710-S, 
GT2708-S
GT2710-V, 
GT2708-V

Base screen
Overlap window 1

0 to 736

0 to 576

0 to 528

0 to 416
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(1) Setting the display position
Set the display position with a multiple of 2 (dots).
Even if the display position is set with a value other than a multiple of 2 (dots), the position is automatically adjusted to a 
multiple of 2 (dots).

(2) Video window placed beyond the screen
If the video window is placed beyond the screen, display position of the video window is automatically adjusted to fit to 
the screen.

(3) Order of displaying the video window
The video window can be displayed over or behind the overlap window (1 or 2) or test window according to the setting 
for the [Video/RGB Input Common] device.

➟10.6.5 [Video/RGB Input] dialog
However, the following items are displayed over the video window.
• Alarm popup display
• Key window
• Comment window
• Confirmation or similar message displayed on the GOT

■3 Moving the video window
The video window does not have the move button.
To move the video window, change the device values set for the display position (X and Y coordinates).
If multiple video windows are moved frequently, the overlap window may not be moved even when the window is touched.
In this case, move the overlap window by changing the device values or move it after moving the video window is completed.

■4 Placing the video window on the overlap window
(1) The video window can be placed on the overlap window 1 only.

(2) Each window displayed on the front of the overlap window 1 is displayed over the video window.
For the display order of each window, refer to the following.

➟1.2.3 Screen types and the specifications

(3) When the video window is placed on the overlap window 1, transparent processing will be 
automatically executed for the video window.

➟■9 Transparent processing
If figures or objects are set on the overlap window, figures or objects may be visible in the background of the video 
window.

(4) If the display position (base screen or overlap window 1) is switched while the video window is 
displayed, the video window is closed temporarily and then opened at the specified position (base 
screen or overlap window 1).

(5) The size of the video window placed on the overlap window is not changed even when the video 
window is touched.
To change the size of the video window, change the value of the device set for window size change.

➟10.6.5 [Video/RGB Input] dialog
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■5 Displaying in the full mode
In the full mode, an image taken by a video camera is displayed on the GOT in the actual size.
When the full mode is used, up to four video windows can be displayed simultaneously.
It is also possible to display images taken by different video cameras in one video window by switching the channel No.

(1) Resolution and display size of the video window
The following shows the resolution of video windows that can be displayed in the full mode.
640×480 dots, 720×480 dots, 768×576 dots
The display size of each video window can be changed in three levels (100%, 50%, or 25%).

*1 The same resolution is set for 4 channels.

Video image

Image taken by a video camera is displayed in the actual size.

Display size
Resolution of video windows (dots)*1

640×480 720×480 768×576

100% 640×480 720×480 768×576

50% 320×240 360×240 384×288

25% 160×120 180×120 192×144
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(2) Changing the display size
The following shows changing the display size of the video window.

(a) Changing the size by touching the video window
(Changing the size by touching can be disabled by turning on b4 of the [Video/RGB Input Common] device.)

➟■9 Transparent processing

When the video window display size is changed by touching, the window size changes as follows.
• Display size change

Display size: 25% → Display size: 50% → Display size: 100% → Display size: 50% → Display size: 25%
When the video window is displayed at 25% magnification of the first touch changes the magnification of display size 
to 50%. When the video window is displayed at 50% magnification, the first touch changes the magnification to 100%.

(b) Changing the size by writing a value to the display size setting device
The following shows the window display sizes corresponding to values to be written.

• 0: 100%
• 1: 50%
• 2: 25%

(3) Displaying the multiple video windows
(a) The last displayed video window is located at the topmost position.
(b) The video window, of which the display position or size is changed, is displayed in the topmost 

position.
(c) When video windows are superimposed, the hidden video window is displayed in the topmost position 

when it is touched.
If transparent processing is executed, video windows do not operate as above.

(d) Do not display the same image (taken by the same channel) in multiple video windows.
If you display the same image in multiple video windows, the image is displayed only in the video window assigned with the 
smallest number and not displayed in other video windows.

Display size: 25% Display size: 50% Display size: 100%

 

Display size: 25% Display size: 50% Display size: 100%

(Channel No.)
(Display size)
(X-coordinate)
(Y-coordinate)

D105
D106
D107
D108

1→1→1
2→1→0
32→32→32
32→32→32
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(4) Invalid area of a touch switch around the video window
Depending on the size of displayed video window, the following areas are invalid for the touch switch.

Precautions for using the full mode
• When the display size of the video window is returned to the previous display size by touch operation, the 

display position is also returned to the position when the video screen was displayed.
• If the resolution of a video image is higher than that of the video window displayed on the GOT, a part of 

the image is not displayed in the video window.
The image display position can be adjusted by changing the setting for the video display setting items of 
the utility.

• If the resolution of the video window displayed on the GOT is higher than that of the video image, an 
indefinite image is displayed in the window area where the video image is not displayed.

■6 Displaying in the clip mode
This mode is used to specify a part (clip area) of the image taken by a video camera and display it in the original size on the 
GOT.
With this mode, the video window display area can be reduced without reducing the size of the image to be displayed.
The clip mode can be used only in video window 1.
The clip mode cannot be used in video window 2 to 4.

Display size
Resolution of video windows (dots)

768×576 720×480 640×480

100% 768×576 (No invalid area) 720×480 (No invalid area) 640×480 (No invalid area)

50% 384×288 (No invalid area) 360×240 (Invalid area: Right 8 dots) 320×240 (No invalid area)

25% 192×144 (No invalid area) 180×120 (Invalid area: Right 12 dots, 
Lower 8 dots) 160×120 (Invalid area: Lower 8 dots)

Down

Right : Touch switch valid area

: Touch switch invalid area

: Touch switch area invalid

Video window

The specified part of video image is displayed in the actual size.

Video image

Specified 
part
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(1) Selecting a clip area
To set a clip area, specify the upper left corner of the part of the video image to be displayed by its coordinate values and 
specify the vertical size (Y: 64 to 768 dots) and the horizontal size (X: 64 to 576 dots).

(2) Operations of video windows 2 to 4 in the clip mode
(a) When switched from the full mode to the clip mode

If the mode is switched from the full mode to the clip mode while any or all of video windows 2 to 4 are open, these video 
windows are erased forcibly.

(b) When switched from the clip mode to the full mode
When the mode is switched back from the clip mode to the full mode, any or all of video windows 2 to 4 are displayed 
according to the channel number, display position, and display size specified at that timing.

■7 Displaying a still image
The video image displayed in the full or clip mode can be switched to a still image.
When multiple video windows are displayed in the full mode, the video images displayed on the multiple video windows are 
all switched to still images.

Precautions for using a still image
(1) Operations that are invalid during still image display

The operations indicated below are disabled during still image display.
To enable these operations, switch the mode back to the motion video mode.
• Changing the video window channel
• Changing the display size
• Changing the display position
• Erasing the video window
• Displaying the video window

(2) Video window on the overlap window
When the image in the video window placed on the overlap window is switched to a still image, do not 
move the overlap window.
If the overlap window is moved, the still image is not displayed.

(3) Turning the GOT ON
When a still image is displayed (motion video/still image selection bit: ON), do not power on the GOT.
If the GOT is powered on while the bit is on, the video window cannot be displayed.

Set the Y display size.

Set the coordinate values of the upper left corner part 
of the video image to be displayed in the clip mode.

Set the X display size.

Video image

… b5 b4 b3 b2 b1 b0D10

OFF→ON

(Motion video/still image selection bit ON: b5)
Turn the bit on to switch a motion video to 
still image.
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10
■8 Setting items of [Video/RGB Input Common] device
The device specified for the [Video/RGB Input Common] stores the data as indicated below.
Turning on/off the bit devices controls the operation of the video window and RGB screen.
The settings for the video window are used in common to video windows 1 to 4.

*1 When b7 is on, b0 is disabled and the mode is fixed to the clip mode.
*2 When this bit is turned on with other bits at the same time, the contents of other bits are disregarded. (b5 has priority.)
*3 The contents of control depend on the setting values for selecting transparent processing (b2).
*4 When b7 is off and GS449.b0 is on, an RGB screen is displayed on the middle side.

When b7 is off and GS449.b0 is off, the value set in b13 is enabled.
When b7 is on, the values set in GS449.b0 and b13 are disabled and the Extended Control signal determines the display 
position of the video window.
➟■11 Video window or RGB screen when the extended control is enabled

*5 When a user-created screen is displayed on the GOT, an RGB screen is displayed with bit on.
*6 When both b14 and b15 turn on, b15 has priority.

Bit number Description Bit status Remarks

b0*1 Selecting the full mode or clip mode ON: Selects the clip mode. OFF: Selects 
the full mode.

Valid when the video window is displayed. Bit 
status can be changed while the video 
window is displayed.

b1 Selecting the screen for placing the video 
window

ON: Selects the overlap window 1. OFF: 
Selects the base screen.

Transparent processing is executed 
automatically when b1 is ON.

b2 Selecting the transparent processing
ON: Executes the transparent processing. 
OFF: Does not execute the transparent 
processing.

➟■9 Transparent processing

b3 Selecting how to specify the transparent 
color

ON: Makes colors other than the specified 
color transparent. OFF: Makes the specified 
color transparent.

b4
Selecting whether the display size of the 
video window is changed or not when the 
video window is touched

ON: Does not change the size. OFF: 
Changes the size.

Valid when the video window is opened. Bit 
status can be changed while the video 
window is displayed.

b5 Selecting a motion video or still image*2 ON: Selects a still image. OFF: Selects a 
motion video. ➟■9 Transparent processing

b6*3

Selecting display priority for video 
windows (When b2 (selecting 
transparent processing) is OFF.)

ON: Displays the video window over the 
overlap window or test window.
OFF: Displays the video window behind the 
overlap window or test window.

Valid when the video window is opened. Bit 
status can be changed while the video 
window is displayed.

Selecting transparent processing target 
screen (When b2 (selecting transparent 
processing) is ON.)

ON: Base screen only OFF: Base screen 
and overlap window 1 and 2 -

b7*4 Extended control ON: Extended control enabled OFF: 
Extended control disabled

➟■11 Video window or RGB screen when 
the extended control is enabled

b8 to b9 Use prohibited - -

b10 Selecting the number of transparent 
color

ON: 65536 colors mode OFF: 256 colors 
mode ➟■9 Transparent processing

b11 to b12 Use prohibited - -

b13*4 Display position of the RGB screen ON: Displays on the middle side. OFF: 
Displays on the upper left side. ➟■9 Transparent processing

b14 Selecting displaying or hiding the RGB 
screen (CH2)*5*6

ON: Displays the RGB screen. OFF: 
Displays the GOT monitor screen.

Valid when mounting GT27-R2-Z
➟■9 Transparent processing

b15 Selecting displaying or hiding the RGB 
screen (CH1)*5*6

ON: Displays the RGB screen. OFF: 
Displays the GOT monitor screen. ➟■9 Transparent processing
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■9 Transparent processing
(1) Displaying transparent processing

Specify the transparent color to display objects or figures located behind the video window.
Select the transparent color from the specified color or the colors other than the specified color.
When multiple video windows are displayed, transparent processing is performed on all windows.

Example)

(a) Placing the video window on the overlap window
When the video window is placed on the overlap window 1, the transparent processing is automatically executed even if 
the transparent processing selection bit (b2) is OFF.

(b) Touch switches, numerical input, and text input behind the video window
By executing the transparent processing, objects such as touch switches, numerical input, and text input functions behind 
the video window are made visible.
(While the transparent processing is applied, the video window size does not change even if the video window is touched.)

(2) Display examples (with and without transparent processing)
(a) When transparent processing is not executed

The video window is displayed over the base screen.
For overlap and test windows, it is selectable whether the video window is placed over or behind an overlap or test window.

(b) When transparent processing is executed
The video window is displayed behind the base screen.
If the target of transparent processing is only the base screen, the overlap window is not made visible.
If both the base screen and the overlap window are set as the target of transparent processing, both of them are made 
visible.

Transparent color specification 
method selection bit: b3

Transp
arent 
color

Display

OFF (makes the specified color 
transparent) 0(black) Figures or objects of colors other than black are visible on the video window.

ON (makes colors other than the 
specified color transparent) 0(black) Figures or objects in black color are visible on the video window.

The figures and objects of the specified 
color are made visible.

OFF→ON

(Transparent processing selection bit ON: b2)
Turn the bit on to execute the transparent 
processing. (Transparent color specification 
method selection bit ON: b3)
Turn the bit on to make the specified color 
transparent.

OFF→ON
………… b3 b2 b1 b0D10

A FED
B CDE

A FED
B CDE

Back displayFront display

A FED
B CDE

A FED
B CDE

Transparent processing target
   Base screen
   Overlap window

Transparent processing target
   Base screen

A FED
B CDE

A FED
B CDE
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■10 Usage examples of the video window
The following shows the usage examples of video window.

(1) Switching the channels by the touch switch
The channel displayed on the video window 1 is switched each time the touch switch is touched.

The following shows the example of the setting when D100 is set in the start device.

(2) Enlarging the screen as necessary
(a) In a normal state, small-size video windows are displayed at the bottom of the screen and the video 

windows are enlarged as necessary. (The size is changed by the sequence program or the touch 
switch.)

The following shows the example of the setting when D100 is set in the start device.

Item Device Setting

[Video Window1]

[CH No.] D106 1 → 2 → 3 → 4 → 1···Repeated

[Size] D107 0

[X Position] D108 32

[Y Position] D109 32

Channel 1 Channel 2 Channel 3 Channel 4

Item Device Setting

[Video Window1]

[CH No.] D106 1

[Size] D107 2

[X Position] D108 32

[Y Position] D109 480

[Video Window2]

[CH No.] D110 2

[Size] D111 2

[X Position] D112 208

[Y Position] D113 480

[Video Window3]

[CH No.] D114 3

[Size] D115 2 → 0

[X Position] D116 384 → 32

[Y Position] D117 480 → 0

[Video Window4]

[CH No.] D118 4

[Size] D119 2

[X Position] D120 560

[Y Position] D121 480
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(b) In a normal state, small-size video windows are displayed at the bottom of the screen and the video 
windows are enlarged one by one as necessary. (The size is changed by the touch switch and script.)

The following shows the example of the setting when D100 is set in the start device.

Write a script that repeats the following operations each time the touch switch is touched.
• Window 1: Small → Large
• Window 1: Large → Small

Window 2: Small → Large
• Window 2: Large → Small

Window 3: Small → Large

(c) In a normal state, a part of the video image is displayed at the bottom of the screen, and the video 
image is switched to the display of the full size as necessary. (The video display mode is switched 
between the full mode and clip mode by the sequence program or the touch switch.)

The following shows the example of the setting when D100 is set in the start device.

Item Device Setting

[Video Window1]

[CH No.] D106 1

[Size] D107 2 → 0 → 2

[X Position] D108 32 → 32 → 32

[Y Position] D109 480 → 0 → 480

[Video Window2]

[CH No.] D110 2

[Size] D111 2 → 2 → 0

[X Position] D112 208 → 208 → 32

[Y Position] D113 480 → 480 → 0

[Video Window3]

[CH No.] D114 3

[Size] D115 2

[X Position] D116 384

[Y Position] D117 480

[Video Window4]

[CH No.] D118 4

[Size] D119 2

[X Position] D120 560

[Y Position] D121 480

Item Device Setting

[Video/RGB Input Common] D100 Selecting the full mode or clip mode D100.b0: ON 
→ OFF

[Video/RGB Transparent Color]
[0 to 65535] or 
[0(Black) to 
255(White)] *1

D101 Selecting a transparent color
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*1 When b10 is turned on by the [Video/RGB Input Common] device, [0 to 65535] is applied, and when turned off, [0(Black) to 
255(White)] is applied, respectively.

(3) Changing the display position of video image
A part of a video image is displayed at the bottom of the screen and the display position is switched as necessary. (The 
X and Y coordinates of the area to be clipped are switched by the sequence program or the touch switch.)

The following shows the example of the setting when D100 is set in the start device.

*1 When b10 is turned on by the [Video/RGB Input Common] device, [0 to 65535] is applied, and when turned off, [0(Black) to 
255(White)] is applied, respectively.

■11 Video window or RGB screen when the extended control is enabled
When b7 (Extended Control signal) of the video and RGB input common device is on, the video window is always displayed 
in the clip mode.
The value of b0 (selecting the full and clip mode) of the video and RGB input common device is disabled.
To disable the extended control function, refer to the following.

➟■8 Setting items of [Video/RGB Input Common] device
When the extended control is enabled, the following functions are available.

(1) Full-screen display
To display the video window or RGB screen in full-screen size, specify the video window or RGB screen to the Full-screen 
Display Control signal (GS1998).
When a value other than the following is specified, the video window or RGB screen operates in the same way as 0.
0: Does not display the video window in full-screen size. (The window display size corresponds to the setting of each 
video window or RGB screen.)
1 to 4: Displays the specified number of video window in full-screen size. 
5: Displays the RGB screen in full-screen size.

[Clip]

[X Position] D102 70

[Y Position] D103 50

[Width] D104 256

[Height] D105 256

[Video Window1]

[CH No.] D106 1

[Size] D107 0

[X Position] D108 32

[Y Position] D109 400 → 32

Item Device Setting

Item Device Setting

[Video/RGB Input Common] D100 Selects the clip mode.

[Video/RGB Transparent 
Color]

[0 to 65535] or 
[0(Black) to 
255(White)]*1

D101 Selecting a transparent color

[Clip]

[X Position] D102 70 → 90 → 80

[Y Position] D103 50 → 60 → 20

[Width] D104 256

[Height] D105 256

[Video Window1]

[CH No.] D106 1

[Size] D107 0

[X Position] D108 112

[Y Position] D109 112
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(2) Display setting of the video window
To display the video window or RGB screen on the GOT in the full-screen display or the clip display, configure the 
following setting.
The display position of the video window or RGB screen is specified by using the upper left corner of the GOT screen as 
the origin point of coordinates.

*1 Specify a channel number with b14 and b15 of the device specified for [Video/RGB Input Common].

➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device

Device
Function

Video window 1 Video window 2 Video window 3 Video window 4 RGB window

GS1999 GS2009 GS2019 GS2029 *1 Specify the channel No. of the video window.

GS2000 GS2010 GS2020 GS2030 GS2039

Specify the display magnification of the video window or 
RGB screen. The display size, which is specified in the 
display size setting (width and height) for the video 
window or RGB screen, is used as the reference.
• 7: 400%
• 8: 200%
• 0: 100%
• 1: 87.5%
• 2: 75%
• 3: 62.5%
• 4: 50%
• 5: 37.5%
• 6: 25%
• Other than the above: 100%

GS2001 GS2011 GS2021 GS2031 GS2040

Specify the display size (width) of the video window or 
RGB screen in dots by using the size at 100% 
magnification as the reference. The actual display size 
(width) of the video window or RGB screen is enlarged 
or reduced according to the set display magnification. 
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2002 GS2012 GS2022 GS2032 GS2041

Specify the display size (height) of the video window or 
RGB screen in dots by using the size at 100% 
magnification as the reference. The actual display size 
(height) of the video window or RGB screen is enlarged 
or reduced according to the set display magnification. 
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2003 GS2013 GS2023 GS2033 GS2042

Using the upper left corner of the GOT screen as the 
origin point of coordinates, specify the display position 
(X coordinate) of the video window or RGB screen in 
dots. Specify the display magnification within a range of 
the lower resolution in the video image or the GOT.

GS2004 GS2014 GS2024 GS2034 GS2043

Using the upper left corner of the GOT screen as the 
origin point of coordinates, specify the display position 
(Y coordinate) of the video window or RGB screen in 
dots. Specify the display magnification within a range of 
the lower resolution in the video image or the GOT.

GS2005 GS2015 GS2025 GS2035 GS2044
Specify the origin point (X coordinate) of the clip area of 
the video image. Specify the display magnification 
within a range of the resolution of the video image.

GS2006 GS2016 GS2026 GS2036 GS2045
Specify the origin point (Y coordinate) of the clip area of 
the video image Specify the display magnification within 
a range of the resolution of the video image.
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(a) Displaying the video image with the clip display by controlling the devices

(b) Clip display when the display magnification is changed
If any other than 100% is set for the display magnification, the size of the video window displayed on the GOT is enlarged 
or reduced according to the set display magnification.

• Display example when the display magnification is 100% or 50%

• Display example when the display magnification is 25%

Video image

Clip area

Displaying the video image controlled with the GOT internal devices

Specify the display size (width and height) 
of the video window.

Specify the display position (X and Y 
coordinates) of the video window. 
The default display position is the upper 
left corner of the GOT screen.

Specify the origin point (X and Y 
coordinates) of the clip area of 
the video image.

The width and height of the video 
window determines the clip area of 
the video image.

Video image

Clip area 
(Width)

Clip area 
(Height)

Set 50% for 
the display 
magnification.

Clip area

Set 100% for 
the display 
magnification.

Clip display when 0 (100%) is set in the display 
magnification of the video window.

Clip display when 4 (50%) is set in the display 
magnification of the video window. Display area of the video image when 50% is set 

in the display magnification.

Actual display size of 
the video window 
(320, 240)

Display size 
(320, 240)

Actual display size of 
the video window 
(320, 240)

Origin point 
(X and Y coordinates) 
of the clip area

Set 25% for 
the display 
magnification.

Clip display when 6 (25%) is set in the display 
magnification of the video window.

Video image

Display area of the video image when 25% is set 
in the display magnification.

Clip area with the origin 
point adjusted

The objects and figures 
on the GOT screen are 
displayed on the shaded 
area.

Origin point 
(X and Y coordinates) 
of the clip area
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10.6.5 [Video/RGB Input] dialog

Not available to GT2705-V.
Select [Common] → [Peripheral Setting] → [Video/RGB Input] from the menu to display the setting dialog.
This dialog is common to the following functions.

• Video/RGB display object
• Video display function
• RGB display function

1) [Destination I/F]
Set the interface of the GOT.
The following shows the items to be selected.

• [Extend I/F(1st)]
• [Not connected]

Click the [Detail Setting] button to display the detail setting dialog for the video and RGB input.

• [Video Input Signal]
Select the video input signal
The following shows the items to be selected.
• [NTSC]
• [PAL]

• [Video Resolution]
Select the video resolution.
The following shows the items to be selected.
• [640×480]
• [720×480]
• [768×576]

This item is fixed to [640×480] when [NTSC] is selected for [Video 
Input Signal].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

5)

When [Unit Type Name] is set to [GT27-R2 (RGB Screen only)]

6)

4)
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2) [Use Video/RGB Input]
Enables the following functions.

• Video/RGB display object
• Video display function
• RGB display function

3) [Unit Type Name]
Select an option unit model according to the function used.
The following shows the items to be selected.

• [GT27-V4-Z/GT27-V4R1-Z]
• [GT27-R2-Z (RGB Screen only)]
• [GT27-R2 (RGB Screen only)]

4) [Video Window]
This item appears when [Unit Type Name] is set to [GT27-V4-Z/GT27-V4R1-Z].
Set the number of video windows displayed.
The setting range is [1] to [4].

5) [First Device]
This item appears when [Unit Type Name] is set to [GT27-V4-Z/GT27-V4R1-Z] or [GT27-R2-Z (RGB Screen only)].
Set the first device to be used.
By setting the first device, consecutive devices are automatically assigned to the following items.

Item Description

[Video/RGB Input Common]
Device to display a video window or the RGB screen The device value is handled as a 16-bit binary.
➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device

[Video/RGB Transparent Color]

This item appears when [Unit Type Name] is set to [GT27-V4-Z/GT27-V4R1-Z]. Specify the transparent 
color for the transparent processing. Transparent color depends on the bit device set by b10 of [Video/
RGB Input Common].
• When b10 is on: 0 to 65535
• When b10 is off: 0 (Black) to 255 (White)

➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device

[Clip]

This item appears when [Unit Type Name] is set to [GT27-V4-Z/GT27-V4R1-Z].
• [X Position]: Specify the X coordinate to display a video image when the clip mode is used.
• [Y Position]: Specify the Y coordinate to display a video image when the clip mode is used.
• [Width]: Specify the width of a clipped image.
• [Height]: Specify the height of a clipped image.

[Video Window1], [Video Window2], 
[Video Window3], [Video Window4]

This item appears when [Unit Type Name] is set to [GT27-V4-Z/GT27-V4R1-Z]. The related setting items 
appear for each video window according to the set value of [Video Window].
• [CH No.]: Specify the channel number displayed on a video window.

The setting range is [1] to [4].
• [Size]: Specify the display size of the video window.

The following shows the setting range for the display size.
· 0: 100%
· 1: 50%
· 2: 25%
When the display size of the video window is changed by touching the window, the value of the set 
device remains unchanged.

• [X Position]: Specify the X coordinate of the video window.
• [Y Position]: Specify the Y coordinate of the video window.
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6) [Display Mode]
This item appears when [Unit Type Name] is set to [GT27-R2 (RGB Screen only)].
Set the GOT display mode for the video/RGB display object.
For the details of [Display Mode], refer to the following.

➟8.27.1 ■9 Display mode
The following shows the items to be selected.

• [Display on the foreground]:
Displays a video/RGB display object in front of the other figures and objects on the same screen.
Overlapping figures and objects are hidden under the video/RGB display object.
The transparent function is disabled.

• [Display on the specified color area]:
Displays a video/RGB display object behind the other figures and objects on the same screen.
The transparent function is enabled.
Select a color to become transparent.

➟6.4.2 Color settings
If [Set screen background color] is enabled in the [Screen Property] dialog for a target screen, set the same color 
for [Front Layer Transparent Color].
Otherwise, the video/RGB display object is hidden under the background color.

• [Display on the area of other colors]:
Displays a video/RGB display object behind the other figures and objects on the same screen.
The transparent function is enabled.
Select a color not to become transparent so that other colors become transparent.

➟6.4.2 Color settings
If [Set screen background color] is enabled in the [Screen Property] dialog for a target screen, set the same color 
for [Front Layer Transparent Color].
Otherwise, the video/RGB display object is hidden under the background color.
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10.6.6 Precautions

Not available to GT2705-V.
This section explains the precautions for using the video display function.

■1 Precautions for drawing
(1) Placing the object on the video window

Objects cannot be placed on the video window.

(2) Displaying the video window, RGB screen, and multimedia screen
The simultaneous display of the video window, RGB screen, and multimedia screen is not available.

(3) Displaying a window with transparency

If a window with transparency is placed on a video window, the video window is invisible.

■2 Precautions for use
(1) Display of a video image
(a) When no video signal is input from a video camera

If a video signal is not input to the specified channel due to cable disconnection or power-off of a video camera, a video 
image is not displayed.

(b) Restrictions when the video display is used with the hard copy or other functions
A video image may be given in still image or disappear temporarily when the hard copy function is executed or when a 
system message is displayed or cleared.

(c) Function unavailable in full screen mode
The hard copy function is not available with the full-screen display.

(d) Precautions for the utility setting
A video image may be disturbed or stopped depending on the setting for [Horizontal] or [Vertical] for the utility (video display 
setting).
(In this case, the normal display will be restored by changing the settings to default values.)
Whether or not such a problem occurs depends on equipment such as a video camera.
Use setting values that allow normal video display
For the operating procedure for the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(e) Restrictions when the video window lies off the GOT screen
The video window may not display a video image properly, if the window lies off the GOT screen.
Make sure that the video window does not lie off the GOT screen.

(2) Output format of a video camera and video input signal setting
Set a video input signal according to an output format of the video camera to be connected as shown below.
If the setting is different, some video images may not be displayed correctly.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2

Output format of video camera Video input signal setting

NTSC format NTSC

PAL format PAL

EIA format NTSC

CCIR format PAL
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(a) When using multiple video cameras
When you use multiple video cameras, refer to the above table. Select a video cameras with output formats that correspond 
to the video input signal setting of the GOT.
One type of video input signal can be set for each project.
When the output format of the video camera does not correspond to the video input signal setting of the GOT, some video 
images may not be displayed correctly.

10.6.7 Relevant settings

Not available to GT2705-V.
Set the relevant settings other than the specific settings for the video display function as required. The following shows 
the functions that are available by the relevant settings.

■1 GOT Internal Device
Enabling b7 of the device specified by [Video/RGB Input Common] enables the extended control.
Use the extended control to display the video window with the full-screen display or the clip display on the GOT.
For the details of the devices, refer to the following.

➟12.1.3 GOT special register (GS)
　 10.6.4 ■11 Video window or RGB screen when the extended control is enabled

GOT side

NTSC

Video camera side

NTSC format

EIA format

GOT side

NTSC 

Video camera side

NTSC format

PAL format

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the input status of the video signal for CH1 is recognized GS252.b8

Checking if the input status of the video signal for CH2 is recognized GS252.b9

Checking if the input status of the video signal for CH3 is recognized GS252.b10

Checking if the input status of the video signal for CH4 is recognized GS252.b11

Controlling the display position for the RGB screen GS449.b0

Specifying the video window or the RGB screen to be enlarged to full screen when the extended control 
is enabled GS1998

Controlling the video window 1 with the GOT internal devices when the extended control is enabled GS1999 to GS2006

Controlling the video window 2 with the GOT internal devices when the extended control is enabled GS2009 to GS2016

Controlling the video window 3 with the GOT internal devices when the extended control is enabled GS2019 to GS2026

Controlling the video window 4 with the GOT internal devices when the extended control is enabled GS2029 to GS2036

Controlling the RGB display with the GOT internal devices when the extended control is enabled GS2039 to GS2045
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10.7 Displaying Image from a Personal Computer on the GOT (RGB 
Display Function)

Not available to GT2705-V.

10.7.1 Overview of the RGB display function

Not available to GT2705-V.
The RGB display function enables screens of the personal computer or others to be displayed on the GOT.

RGB input unit applicable to the RGB display function
Use GT27-R2-Z or GT27-V4R1-Z for the RGB display function.
GT27-R2 is not applicable.
When using GT27-R2, use a video/RGB display object.
➟8.27 Placing a Video/RGB Display Object

10.7.2 Specifications of the RGB display function

Not available to GT2705-V.

■1 System application (extended function)
To use the RGB display function, a system application (extended function) of [Video/RGB] is required.
To incorporate the application into the package data automatically, select [Use Video/RGB Input] and select [GT27-R2-Z 
(RGB Screen only)] or [GT27-V4-Z/GT27-V4R1-Z] for [Unit Type Name] in the [Video/RGB Input] dialog.

➟10.6.5 [Video/RGB Input] dialog

■2 Number of RGB display function settings for one project
One RGB display function setting is available for one project.

■3 Specifications of the RGB display
The following resolutions and refresh rates are applicable to the RGB display function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Resolution Refresh rate (Hz)

XGA (1024 × 768 dots) 60

SVGA (800 × 600 dots) 60/72/75

VGA (640 × 480 dots) 60/72/75/85
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10.7.3 Basic use of the RGB display function

Not available to GT2705-V.
The RGB display function enables various types of displays by using the [Video/RGB Input Common] device.
For the details of the settings, refer to the following.

➟10.7.4 Advanced use of the RGB display function

■1 System configuration
The following shows the system configuration of the RGB display function.

*1 The cable length depends on the specifications of the RGB output device used.
*2 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*3 Two channels (CH1 and CH2) can be set as an input source for the RGB screen. For channel switching, refer to the following.

➟10.6.5 [Video/RGB Input] dialog
*4 Not available to GT2705-V.

■2 Setting procedure
Step 1 Connect the GOT and the RGB output device.

➟■1 System configuration
Step 2 Select [Common] → [Peripheral Setting] → [Video/RGB Input] from the menu to display the [Video/RGB 

Input] dialog.

➟10.6.5 [Video/RGB Input] dialog
Step 3 In the [Video/RGB Input] dialog, set the items as shown below and click the [OK] button.

• [Destination I/F]: [Extend I/F(1st)]
• [Use Video/RGB Input]: Selected
• [Unit Type Name]: [GT27-R2-Z (RGB Screen only)] or [GT27-V4-Z/GT27-V4R1-Z] according to the unit 

used
• [First Device]: Device to control the RGB display function

Step 4 Write the package data to the GOT.
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Display the RGB screen on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Signal type RGB output device Connection 
cable*1

GOT Number of 
connectable RGB 

devicesOption GOT model

Analog RGB

For the connectable RGB output devices, refer to 
the following Technical News.
➟List of Valid Devices Applicable for GOT2000 

Series and GOT SIMPLE Series (for Overseas) 
(GOT-A-0160)

GT15-C50VG 
(5m) or Preparing 
connection 
cables by each 
user*2

GT27-R2-Z*3

GT27*4

Two RGB output 
devices for one GOT

GT27-V4R1-Z One RGB output 
device for one GOT

RGB output device (such as a personal 
computer) GOT

Connection cable
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10.7.4 Advanced use of the RGB display function

Not available to GT2705-V.
The following shows the settings for applicative display by using the RGB display function.

■1 How to display the RGB screen
The RGB screen is displayed on the monitor screen of the GOT according to the on/off setting of the RGB screen display/
hide selection bit (the bit device in the word device).
The RGB screen is displayed through a black colored base screen by making the base screen transparent.
Set the screen color of the base screen to black.
For how to set the screen color, refer to the following.

➟2.7 Changing Screen Property

(1) Display setting
(a) When the resolution of the RGB screen is lower than that of the GOT screen, the RGB display position 

can be changed to the upper left side or the middle side of the GOT.
The display size can also be changed.
Set the RGB display position and size in [Video/RGB Input Common] in the [Video/RGB Input] dialog.
For the setting procedure, refer to the following.

➟10.7.5 [Video/RGB Input] dialog

(b) The RGB display can be performed on the user-created screen only.
For the screens other than the user-created screen (such as the utility and device monitor screen), the RGB display cannot 
be performed.

(c) The display position may be misaligned depending on the RGB output device.
If the display position is misaligned, adjust the position in the utility ([Display Position] in [RGB Display Settings]) of the GOT.
For the details of the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(2) Displaying a window screen
The overlap window and test window are displayed over the RGB screen after composition.
A superimpose window is displayed as a part of the base screen.

(3) Displaying in the clip mode
Specify a part of the RGB screen (clip area) to display it on the GOT in actual size.
To display the RGB screen in the clip mode, configure the settings in [Video/RGB Input Common] in the [Video/RGB 
Input] dialog.
For the setting procedure, refer to the following.

➟10.7.5 [Video/RGB Input] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The monitor screen operates even while 
the RGB screen is displayed.

RGB display

Base screen

Composing the RGB display with 
the base screen (Making the black 
colored base screen transparent)

b15 ……… b2 b0b1D10

OFF→ON

(RGB screen display/hide selection bit ON: b15)
Turning the selection bit ON composes the RGB 
screen with the GOT monitor screen.
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(4) Channel switching for the RGB screen
When the GOT with the GT27-R2-Z is used, select the input source for the RGB screen from CH1 or CH2.
Set the input source channel in [Video/RGB Input Common] in the [Video/RGB Input] dialog.
For the setting procedure, refer to the following.

➟10.7.5 [Video/RGB Input] dialog

(5) Efficient use of the RGB screen
It provides the convenience to place a touch switch without a shape at the position where the RGB screen is displayed, 
and to configure the settings for the touch switch so that the RGB screen is hidden and then the monitor screen is 
displayed.

(a) Hiding the RGB screen
Configure the setting for the touch switch so that the RGB screen display/hide selection bit turns off.

(b) Displaying the monitor screen after hiding the RGB screen
Configure the settings for the touch switch so that the RGB screen display/hide selection bit turns off and the monitor screen 
is displayed.
Example: Hiding the RGB screen

Example: Displaying the monitor screen after hiding the RGB screen

■2 Screen save function of the RGB screen
While the RGB screen is displayed, the power saving function of the personal computer display becomes active, followed 
by the GOT screen save function.
When the power saving function of the personal computer display is not active, the GOT screen save function is disabled 
even if it is set on the GOT.
The RGB screen save is performed as shown below.

Relation between the personal computer status and the validity of the GOT screen save function

Touch switch without a shape
(RGB screen display/hide 
selection bit OFF + Screen 
switching)

Touch the screen while 
the RGB screen is displayed 
(Touch the touch switch)

The RGB screen is hidden, 
and then the monitor screen 
is displayed.

Touch switch without a shape 
(RGB screen display/ hide 
selection bit OFF)

Touch the screen while the RGB 
screen is displayed 
(Touch the touch switch)

The RGB screen is hidden.

Personal computer status Validity of GOT screen save function

Personal computer screen displayed
Invalid (Personal computer screen displayed)

Screen saver operating

Display power saving function operating Valid (Personal computer screen → Monitor screen → GOT screen save mode)

The RGB screen is displayed. When the GOT detects the power saving 
state of the personal computer display, 
the RGB screen is hidden and only 
the monitor screen is displayed.
(Turn on the GOT internal device 
(GS252.b15).)

When the screen save time set 
on the GOT side has passed, 
the GOT becomes the screen 
save mode.
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(1) Screen save operation while monitoring
While the RGB screen is not displayed, the GOT screen save function operates independently of the power saving 
function of the personal computer display.
For the details of the GOT screen save function, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(2) When no RGB signal is input to the GOT
When no RGB signal is input to the GOT due to cable disconnection and others, the GOT internal device (GS252.b15) 
turns on as when the GOT detects the power saving state of the personal computer display.

■3 Acquiring the color information of the touched position
By using the GOT special registers (GS devices), the color information of the touched position can be acquired.

The following shows the procedure to acquire the color information of the touched position.
Step 1 Use the touch switch or others to turn on the Touched Position Color Acquisition Ready signal (GS630.b0).

Turning on the signal makes the GOT be ready for acquiring the color information of the touched position.
The Touch Position Color (GS981 to GS983) stores -1.

Step 2 Touch the position where you acquire the color information.
The Touch Position Color (GS981 to GS983) stores the color information of the touched position.

Step 3 After the acquisition of the color information of the touched position, the Touch Position Color Acquisition 
Complete signal (GS980.b0) turns on.
Then, the GOT stops to acquire the color information.

Step 4 Use the touch switch or others to turn off the Touch Position Color Acquisition Ready signal (GS630.b0).
Turning off the signal also turns off the Touched Position Color Acquisition Complete signal.

(1) Color information that can be acquired
Depending on the liquid crystal display, camera, or others, the acquired color information may not be exactly the same 
as the color of the real image.

GOT GOT

Turn on GS630.b0 with the touch switch or others 
to make the GOT be ready for acquiring the color 
information (RGB values) of the touched position.

The devices of GS981 to GS983 store 
the color information (RGB values) of 
the touched position.

Color acquisition Color acquisition

GS981 R(Red): 180
GS982 G(Green): 150
GS983 B(Blue): 123

GS630.b0: 
OFF→ON

Touch status

Touch Position Color 
Acquisition Ready signal 
(GS630.b0)

Touch Position Color 
(GS981 to GS983)

Touch Position Color 
Acquisition Complete signal 
(GS980.b0)

Previously 
acquired color -1 Acquired color

Turning off GS630.b0 turns 
off GS980.b0.

1.

2.

3.

4.
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(2) Timing when the color information cannot be acquired
The color information cannot be stored in the Touch Position Color (GS981 to GS983) during the following processes.
• Displaying a dialog window
• Moving a window screen
• Returning from the screen save mode
• Screen switching with the operation timing of [When a finger is touched (ON synchronous)]
• Touch operation
• Executing the hard copy function
• The Key-in Disable signal (System signal 1-1.b9) ON
• Acquiring the color information of the touched position
Short touch of the screen may cause the GOT not to recognize the touch operation.
Use the Touch Position Color Acquisition Complete signal (GS980.b0) to check whether the color information has been 
acquired.
When the signal does not turn on, the GOT has not acquired the color information.
Touch the screen again to acquire the color information.

(3) Effect on other functions
Acquiring the color information of the touched position may require a maximum of three seconds.
Therefore, it may cause delay in the processes of the other functions.
The hard copy function is also unavailable while the color information of the touched position is acquired.

10.7.5 [Video/RGB Input] dialog

Not available to GT2705-V.
For the details of the [Video/RGB Input] dialog, refer to the following.

➟10.6.5 [Video/RGB Input] dialog

10.7.6 Precautions

Not available to GT2705-V.
This section explains the precautions for using the RGB display function.

■1 Precautions for drawing
(1) Displaying the video window, RGB screen, and multimedia screen

The simultaneous display of the video window, RGB screen, and multimedia screen is not available.

(2) Displaying a window with transparency

If a window with transparency is placed on the RGB screen, the RGB screen is invisible.

■2 Precautions for use
(1) Object function while the RGB screen is displayed

Each object operates even while the RGB screen is displayed.

(2) Personal computers on which the RGB display is not available
Use the personal computer which meets the resolution requirements indicated in the following reference page.
The personal computer which does not meet the resolution requirements disables the RGB display on the GOT.

➟10.7.2 ■3 Specifications of the RGB display

(3) RGB screen display
(a) Restrictions when the video display is used with the hard copy or other functions

The RGB screen may be displayed as a still image or disappear temporarily when the hard copy function is executed or 
when a system message is displayed or cleared.

(b) Function unavailable in full screen mode
The hard copy function is not available with the full-screen display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2
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(c) Precautions for the utility setting
The RGB display may be disabled, disturbed, or stopped depending on the setting for [Horizontal] or [Vertical] of the utility 
(RGB display setting).
In this case, change the set values to the default values, and then configure the setting within the range that enables the 
RGB display.
For the operating procedure for the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(d) Restrictions when the RGB screen lies off the GOT screen
The RGB screen may not display an RGB image properly, if the screen lies off the GOT screen.
Make sure that the RGB screen does not lie off the GOT screen.

(4) Setting of the resolution and refresh rate for the RGB output device
When the RGB input image is not displayed properly, refer to the following.

➟10.7.2 ■3 Specifications of the RGB display
When the resolution and refresh rate are set outside the range for the RGB output device, the RGB input image is not 
displayed properly.

(5) Resolution of the RGB input image
Set the resolution of the RGB input image to be lower than that of the GOT.
When the resolution of the RGB input image is higher than that of the GOT, only the image which can be displayed within 
the resolution of the GOT is displayed.
To use the RGB input image whose resolution is higher than that of the GOT, take corresponding measures including the 
following.
• Place the display target within the location that can be displayed on the GOT.
• Use the extended control to reduce the display size of the RGB screen.

10.7.7 Relevant settings

Not available to GT2705-V.
Set the relevant settings other than the specific settings for the RGB display function as required. The following shows 
the functions that are available by the relevant settings.

■1 GOT Internal Device
Enabling b7 of the device specified by [Video/RGB Input Common] enables the extended control.
Use the extended control to display the RGB screen with the full-screen display or the clip display on the GOT.
For the details of the devices, refer to the following.

➟12.1.3 GOT special register (GS)
　 10.6.4 ■11 Video window or RGB screen when the extended control is enabled

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Checking if the input status of the RGB signal for CH1 is recognized GS252.b15

Checking if the input status of the RGB signal for CH2 is recognized (when an RGB input unit, GT27-R2 
or GT27-R2-Z, is used) GS252.b14

Controlling the display position for the RGB screen GS449.b0

Making the GOT be ready for acquiring the color information of the touched position GS630.b0

Checking if the acquisition of the color information of the touched position is completed GS980.b0

Acquiring the color information of the touched position GS981 to GS983

Checking the input status of the RGB signal GS1025

Checking the horizontal resolution of the RGB signal GS1026

Checking the vertical resolution of the RGB signal GS1027

Checking the refresh rate of the RGB signal GS1028

Specifying the video window or the RGB screen to be enlarged to full screen when the extended control is 
enabled GS1998

Controlling the RGB display with the GOT internal devices when the extended control is enabled GS2039 to GS2045
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.7 Displaying Image from a Personal Computer on the GOT (RGB Display Function)

10 - 113



10.8 Recording or Playing Images Taken by a Video Camera on the GOT 
(Multimedia Function)

Not available to GT2705-V.

10.8.1 Overview of the multimedia function

Not available to GT2705-V.
The multimedia function enables you to display and record the images taken by the video camera connected to the 
multimedia unit and to play the video files saved in the data storage.
The recorded video images are saved to the CF card installed in the multimedia unit.
The video files recorded in standard mode can be sent to a personal computer by Ethernet.

*1 Only the video files recorded in standard mode can be sent.
For the details of the recording modes, refer to the following.

➟10.8.2 ■4 Specifications of the video display and the recording mode

10.8.2 Specifications of the multimedia function

Not available to GT2705-V.

■1 Required data storage
A multimedia unit requires one CF card.
The GOT also requires a data storage in the following cases.
• Sending a video file from the GOT to the personal computer
• Sending a video file and the log file of a user alarm to a personal computer

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Video camera

Personal computer Multimedia unit

Data storage

The GOT can display video images.
The GOT can play video files in the CF card.

Ethernet

Microphone

The GOT can save video images 
to the CF card in the multimedia unit.

Speaker

Video files can be 
sent from the 
multimedia unit to 
the personal computer 
by Ethernet.*2

Video files can be sent from 
the GOT to the personal 
computer by Ethernet.*1

GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 System application (extended function)
(1) Required system application (extended function)

To use the multimedia function, a system application (extended function) of [Multimedia] is required.
Selecting [Enable the setting of Multimedia] in the [Multimedia] dialog incorporates the application into the package data 
automatically.

➟10.8.6 [Multimedia] dialog

(2) Additional system application (extended function) as needed
To send video files from the GOT to the personal computer, a system application (extended function) of [Gateway(FTP 
Server)] is also required.
Selecting [Use the function of FTP Server] in the [Controller Setting] window incorporates the application into the package 
data automatically.

➟10.16.4 [FTP Server]
However, to send video files from the multimedia unit to the personal computer, the application is not required.

■3 Number of multimedia function settings for one project
One multimedia function setting is available for one project.

■4 Specifications of the video display and the recording mode
The following shows the specifications of displaying and recording video images.

(1) Specifications of the display

(2) Specifications of the recording
(a) When the recording mode is [Standard]

(b) When the recording mode is [Extended]

(c) Destination to save video files
The recorded video files are saved in the 3GPP format to the CF card inserted in the multimedia unit.
When [Save to File Server] in the [Multimedia] dialog is selected, video files are sent to the personal computer by Ethernet 
at the same time when they are saved to the CF card.
(Only the video files recorded in standard mode can be sent.)
For how to send video images to the personal computer by Ethernet, refer to the following.

➟10.8.4 ■6 Interaction method with a personal computer

GOT Video input signal Display size on the GOT

GT27-X, GT27-S
NTSC format 640 × 480 dots (100% magnification)

PAL format 672 × 504 dots (scale-down display at 87.5%)

GT27-V
NTSC format 480 × 360 dots (scale-down display at 75%)

PAL format 480 × 360 dots (scale-down display at 62.5%)

Record size of the video image Video input signal Available frame rate (fps) Bit rate for recording

VGA (640 × 480)
NTSC format 15

1 Mbps
PAL format 12.5

QVGA (320 × 240)

NTSC format
15 384 Kbps

30 768 Kbps

PAL format
12.5 384 Kbps

25 768 Kbps

Record size of the video image Video input signal Available frame rate (fps) Bit rate for recording

QVGA (320 × 240)
PAL format 15

384 Kbps
NTSC format 12.5
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■5 Required software to be installed
(1) Multimedia Interaction Tool

To send video files from the GOT to the personal computer, Multimedia Interaction Tool must be installed to the personal 
computer.
Multimedia Interaction Tool is for receiving and managing video files and alarm log files that are sent from the GOT or 
the multimedia unit by Ethernet on the personal computer.

(a) How to obtain the software
Obtain the software with either of the following methods.

• Disk5 folder in GT Works3 DVD
• Contact your local distributor.

(b) Operating environment
The following shows the operating environment.

*1 For installation, the administrator authority is required.
For Windows 7 and Windows Vista, the standard user or administrator account is required.
To interact GT Designer3 with other MELSOFT applications which are used under the administrator authority, use GT 
Designer3 under the administrator authority.

*2 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Changing your desktop themes (fonts)
• Remote desktop
• DPI setting other than the normal size (For Windows XP and Windows Vista)
• Setting the size of texts and illustrations on the screen to any size other than [Small-100%] (For Windows 7)

*3 Windows XP Mode is not supported.

Item Description

Model Personal computer that Windows runs on.

OS(English version)

• Microsoft Windows 7 Ultimate (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Enterprise (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Professional (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Home Premium (32 bit, 64 bit)*1*2*4

• Microsoft Windows 7 Starter (32 bit, 64 bit)*1*2

• Microsoft Windows Vista Ultimate (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Enterprise (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Business (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Premium (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Basic (32 bit) Service Pack1 or later*1*2

• Microsoft Windows XP Professional (32 bit) Service Pack2 or later*1*2

• Microsoft Windows XP Home Edition (32 bit) Service Pack2 or later*1*2

• Microsoft Windows 2000 Professional Service Pack4 or later*1

CPU The system requirements for the above OSs must be met.*7

Memory The system requirements for the above OSs must be met.*7

Display Resolution XGA (1024 × 768 dots) or higher

Hard disk space
• For installation: For installation: 1 MB or more (excluding setting information, alarm logs, and video files)
• For execution: 500 MB or more (when receiving 10 video files that have the QVGA size, 15 fps, 900 seconds, 

and approximately 42.2 MB per file)*5

Display color High Color (16 bits) or higher

Network connection Ethernet 100Base-TX

Video file 3GPP file, MP4 file (only video available)

Other software

To display Help, the following software must be installed.
• Internet Explorer7 or later recommended

To play and edit a video, the following software must be installed.
• Quick Time Player*6or QuickTime 7 Pro

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD drive
• For execution: mouse, keyboard
Use the following hardware when required.
• For outputting the sound: Sound card, speaker
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*4 Windows Touch is not supported.
*5 The available disk space depends on the data size of alarm logs and video files.
*6 The required version depends on the OS.

• For Windows XP, Windows Vista, and Windows 7: QuickTime 7.4.5 or later
• For Windows 2000: QuickTime 7.1.6 (final version)

*7 For the system requirements for the OSs, refer to the following.

➟Microsoft official website

(c) How to install
To send video images from the multimedia unit to the personal computer, Multimedia Interaction Tool and Multimedia 
Interaction FTP Service must be installed.

➟10.8.5 Multimedia Interaction Tool

(2) Software for playing and editing video files
To play and edit the files collected in the personal computer by using Multimedia Interaction Tool, QuickTime Player or 
QuickTime 7 Pro must be installed.
The software is the copyright of APPLE Inc.
Use the software under the license agreement that appears when installing the software.

(a) Video files that can be played on the GOT
You can play the following saved video files on the GOT.

• 3GPP file
• MP4 file (only video available)

(b) Profile of the MP4 file
To play a MP4 file, use the MP4 file created with MPEG-4 Simple Profile.
MP4 files created with profiles other than the above are unavailable.

(c) How to obtain the software
• QuickTime Player is a software application for playing video.

It is available for free from the website of APPLE Inc.
• QuickTime 7 Pro is a software application for editing video.

It is available for a fee from the website of APPLE Inc.

(d) Playing video files
Set 3GPP- and MP4-format video files to be played by QuickTime Player on the personal computer.
Multimedia Interaction Tool starts the video player that is set on the personal computer to play video files.

(e) Editing video files
Multimedia Interaction Tool has no editing functions for video files.
Edit the video file using QuickTime 7 Pro.
The video files edited by using the software other than the above may not be played.
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10.8.3 Basic use of the multimedia function

Not available to GT2705-V.
The multimedia function enables you to display, play, and record various types of video images by using the [Multimedia] 
dialog.
For the details of the settings, refer to the following.

➟10.8.4 Advanced use of the multimedia function

■1 System configuration
The following shows the system configuration of the multimedia function.

(1) Saving and displaying video images on the GOT

*1 For the types of the connectable video camera, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
*2 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*3 Cable length depends on the specifications of the video camera you use.
*4 For the CF card installed in the multimedia unit, refer to the following.

• Types of usable CF cards

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
• Precautions for using the CF card

➟10.8.7 Precautions
*5 Not available to GT2705-V.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Multimedia 
controller Signal type Connection 

cable Maximum length
GOT Number of connectable 

multimedia controllersOption GOT model

*1 NTSC, PAL

Preparing 
connection 
cables by each 
user*2

*3 GT27-MMR-Z*4 GT27*5 One multimedia controller for one 
GOT

GOT
Video camera, 
microphone, 
speaker

Connection cable
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(2) Sending video images to the personal computer

*1 For the types of the connectable video camera, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
*2 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*3 Cable length depends on the specifications of the video camera you use.
*4 For the CF card installed in the multimedia unit, refer to the following.

• Types of usable CF cards

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
• Precautions for using the CF card

➟10.8.7 Precautions
*5 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.

Connect to the applicable hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other system equipment 
according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*6 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use.
When a repeater hub is used, the number of connectable personal computers is as follows.
• 10BASE-T: Up to 4 for a cascade connection (within 500 m)
• 100BASE-TX: Up to 2 for a cascade connection (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*7 To use the personal computer, install Multimedia Interaction Tool.
For Multimedia Interaction Tool, refer to the following.

Multimedia 
controller

Signal 
type

Connection 
cable 1 GOT*5 Connection cable 2, wireless LAN access 

point
Personal 
computer

*7

Number of 
connectable 
multimedia 
controllersModel

Maxi
mum 
lengt

h

Option 
(Interface 

1)

GOT 
model

Option 
(Interface 

2)
Model

Maximum 
segment 
length*6

*1 NTSC
, PAL

Preparin
g 
connecti
on 
cables 
by each 
user*2

*3 GT27-
MMR-Z*4

GT27
*8

Ethernet 
interface 
(built into 
GOT)

• 10BASE-T
Shielded twisted pair cable 
(STP) or unshielded twisted 
pair cable (UTP): Category 
3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable 
(STP): Category 5 and 5e

100m

Select by 
each 
user

One 
multimedia 
controller 
for one GOT

GT27-
MMR-Z

GT27
*9

GT25-
WLAN - -

GT27
*10

GT25-
WLAN

• Wireless LAN access point
For the connectable 
wireless LAN access points 
and system devices, refer to 
the following Technical 
News.

➟List of Valid Devices 
Applicable for GOT2000 
Series and GOT SIMPLE 
Series (for Overseas) 
(GOT-A-0160)

-

GOT
Video camera, 
microphone, 
speaker

Connection cable 1

Interface 1

Interface 2

Wireless LAN 
access point

Connection cable

Connection cable 2,
wireless LAN access point

Personal 
computer
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➟10.8.5 Multimedia Interaction Tool
*8 Not available to GT2705-V.
*9 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*10 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

■2 Setting procedure
Step 1 Connect the GOT and video equipment.

➟■1 System configuration
Step 2 Configure the settings for the multimedia function in the [Multimedia] dialog.

➟10.8.6 [Multimedia] dialog
Step 3 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 4 Display the multimedia screen on the GOT.
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10.8.4 Advanced use of the multimedia function

Not available to GT2705-V.

■1 Display of a video image on the user-created screen
Setting the items in the [Display Setting] tab in the multimedia setting dialog enables the user-created screen to display a 
video image.
For the details of the settings, refer to the following.

➟10.8.6 ■4 [Display Setting] tab
Functions equivalent to the video display function are available for the video images displayed on the user-created screen.
Only one channel can be used for the multimedia function.

➟10.6.5 [Video/RGB Input] dialog
Recording and playing video images are unavailable when a video image is displayed on the user-created screen.
Only displaying video images is available.

■2 Display of a video image
Connecting a video camera, a microphone, and a speaker to the multimedia unit enables the multimedia screen on the GOT 
to display a video image with sound.

■3 Recording of a video image
Connecting a video camera and a microphone to the multimedia unit enables the GOT to record a video image with sound.
The following methods are provided for recording.

(1) Recording images currently displayed
The GOT records the video image displayed on the multimedia screen of the GOT by the user operation.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Video camera

GOT

The GOT displays 
video images.

Multimedia unit

Microphone

Speaker

GOT

Video camera

Multimedia unit

Touch the record 
button.

The GOT displays 
video images.

1

2

3 The video image is saved 
to the CF card in the 
multimedia unit.

Microphone

Speaker
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(2) Recording before and after the event
The GOT records a video image of before and after an event trigger device turns on for up to 120 seconds.
When the setting for recording before and after the event is enabled, the multimedia unit always holds a video image of 
before 120 seconds.
When an event trigger device turns on, a video image recorded before and after the device turns on is stored in the CF 
card.
Example) Saving a video image 60 seconds before and after an event trigger device turns on

• Use with the user alarm
Using the multimedia function with the user alarm enables the GOT to record a video image before and after an alarm 
occurs.
Use the trigger action and script to set an event trigger device to turn on when a user alarm is detected.
Example) Saving a video image before and after a user-specified alarm occurs

Video camera

Multimedia unit

GOT

Microphone

The multimedia unit always 
retains the video image of 
the last 120 seconds 
before the current time.

Event trigger device
ON

The video image of the time period between 60 seconds 
before and after the event is saved to the CF card.

An error occurs!

GOT

Video camera

Multimedia unit
An error occurs!

On status of M1002 
is detected.

An alarm occurs!

The event trigger device 
turns on according to the 
trigger action.

GB500: OFF → ON

The video image before 
and after the occurrence 
of the alarm is saved.

The error is detected.
M1002: OFF → ON

PLC

1

4

2

3

Microphone

Trigger device of the 
user alarm: M1002
Event trigger device: GB500
Trigger action: If M1002 
turns on, GB500 turns on.

If an error occurs, M1002 
turns on.

•
 
• 
• 

•

GOT settings:

Condition arranged with PLC settings:
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(3) Long time recording
Setting [Extended] for the recording mode enables the GOT to record a video image for up to approximately 3000 
minutes.
In the long time recording mode, a video file is divided into multiple files, and files are separately saved in the specified 
folder. (A video file is created per recording of approximately 7.5 minutes. Up to 400 video files can be saved.)
If the name of a video file is the same as that of a video file in the CF card when the recording starts, all the files in the 
CF card are deleted, and then the GOT starts recording.

For how to set the long time recording, refer to the following.
➟10.8.6 ■1 [Recording Setting] tab

(a) Recording loop
When [Recording Loop] is selected in the recording setting, the GOT can continue recording after recording 400 files 
(approximately 3000 minutes) by overwriting the existing files from the oldest one.
In the recording loop, the GOT continues recording until the user stops recording.

For how to set the recording loop, refer to the following.
➟10.8.6 ■1 [Recording Setting] tab

Video camera

GOT Multimedia unit

Microphone

Speaker

Old New

3000 minutes0 minute

February 3
10:00

February 3
10:07

February 3
10:15

1 2 3
February 5
11:52

February 5
11:45

399 400

Video file

Video camera

GOT Multimedia unit

Microphone

Speaker

Old New

The oldest video file 
is overwritten.

3000 minutes

February 3
10:00

February 3
10:07

February 5
11:52

February 5
11:45

February 5
12:00

February 3
10:15

Video file

(+) and 
increasing0 minute

1 2 3 399 400 401
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(b) Continuous recording (Enabled only when the recording loop is set)
When continuous recording is enabled, the GOT starts recording creating a new file that follows the latest existing file.
In this case, the existing video files are not deleted.

Configure the settings for continuous recording on the GOT utility.
For the setting procedure, refer to the following.

➟GOT2000 Series User's Manual (Utility)
• Recording time and data size per file

In the long time recording, the available recording time of a video file is up to approximately 7 minutes and 30 seconds 
per video file (approximately 20 MB).
The GOT records a video file for a minimum of 7 minutes and 30 seconds.
Even for recording more than 7 minutes and 30 seconds, the data size of the file does not change.
The GOT may stop recording before the recording time reaches 3000 minutes depending on the data size of the CF 
card.
For the long time recording, reserve sufficient available space in the data storage.

Existing video files 
SS_000 to 002

February 1
10:00

February 1
10:07

February 1
10:15

1 2 3
February 3
10:00

4

New video files 
SS_003 

Recording starts with a new file following the latest 
existing video file.

SS_000 SS_001 SS_002 SS_003

After existing video files are deleted, recording starts.

Existing video files 
SS_000 to 002

February 1
10:00

February 1
10:07

February 1
10:15

1 2 3
February 3
10:00

1

New video files 
SS_000

SS_000 SS_001 SS_002 SS_000

When the long time recording is enabled When the long time recording is disabled
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(4) Notifying the amount of usage of the CF card or the number of video files in the card in the multimedia 
unit
You can use specific GOT special registers (GS) to receive notification that the amount of usage of the CF card or the 
number of video files in the card in the multimedia unit reaches a certain amount.

➟12.1.3 GOT special register (GS)
This function is usable only when [Enable] is selected and [Event Trigger Device] is set in [Before-After Event Recording 
Setting] on the [Recording Setting] tab of the [Multimedia] dialog.

The Memory Card Usage signal (GS1022.b0 to GS1022.b1) or the Number of Memory Card Files signal (GS1022.b2 to 
GS1022.b7) turns on according to the amount of usage of the CF card or the number of video files in the card.

The following shows the procedure to notify the amount of usage of the CF card and the number of video files in the card.
Step 1 Turn on the Start Video File Information Notification signal (GS522.b1) by using functions such as a touch 

switch.
Accordingly, the GOT becomes enabled to notify the amount of usage of the CF card and the number of 
video files in the card.

Step 2 The Memory Card Usage signal (GS1022.b0 to GS1022.b1) or the Number of Memory Card Files signal 
(GS1022.b2 to GS1022.b7) turns on according to the amount of usage of the CF card or the number of video 
files in the card.

Step 3 To disable the notification, turn off the Start Video File Information Notification signal (GS522.b1) by using 
functions such as a touch switch.
Accordingly, the Memory Card Usage signal (GS1022.b0 to GS1022.b1) and the Number of Memory Card 
Files signal (GS1022.b2 to GS1022.b7) turn off.

Device Description

GS1022.b0 The amount of usage of the CF card reaches 60%.

GS1022.b1 The amount of usage of the CF card reaches 80%.

GS1022.b2 The number of video files in the CF card reaches 80.

GS1022.b3 The number of video files in the CF card reaches 110.

GS1022.b4 The number of video files in the CF card reaches 150.

GS1022.b5 The number of video files in the CF card reaches 400.

GS1022.b6 The number of video files in the CF card reaches 450.

GS1022.b7 The number of video files in the CF card reaches 500.

CFカード

GOT

Multimedia unit

When GS522.b1 turns on, 
the GOT becomes enabled 
to notify the amount of usage 
of the CF card and the number 
of video files in the card.

GOT

Multimedia unit

CF card CF card

The amount of usage 
of the CF card reaches 60%.

GS1022.b0 turns on, 
and the GOT notifies 
that the amount of usage 
of the CF card has reached 60%.
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(5) Playing video files
Video files saved in the CF card in the multimedia unit can be played on the multimedia screen on the GOT.
The speaker connected to the multimedia unit outputs the sound of a video file.

• Playing a video file from the monitor screen
Setting the name of a video file to be played by using the special function switch enables the GOT to play the file directly 
with the touch switch on the monitor screen.

(6) Hard copy
You can save the image of the entire screen including the image currently displayed to the data storage as a BMP or 
JPEG file.

GOT

Multimedia unit

Video files stored in the CF card are 
played on the multimedia screen.

Speaker

Play

Error details....

Touch the special function switch with 
which the video file to be played is set!

GOT

Multimedia unit

The video file which was set with 
the special function switch is played.

GOT

Video camera

Multimedia unit

Touch the hard copy 
start button.

Data 
storage

The image of the 
entire screen is saved 
to the data storage.

1

2
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(7) Interaction with a personal computer
Using Multimedia Interaction Tool enables the personal computer to receive video files and alarm log files that are sent 
from the GOT or the multimedia unit.
(Only the video files recorded in standard mode can be sent.)
The received video files and alarm log files can be combined for list display and search.

(a) Sending a video file ([Recording Mode]: [Standard])
Video files can be sent from the GOT or the multimedia unit to the personal computer by Ethernet.
With the video files created using the recording before and after the event function, the alarm log files of user alarms can 
be sent simultaneously.

• Sending a video file from the multimedia unit to a personal computer
Connect the multimedia unit to a personal computer by Ethernet to send a video file to the personal computer.
To send alarm log files to the personal computer, a data storage must be installed on the GOT.

• Sending a video file from the GOT to a personal computer
Connect the GOT to a personal computer by Ethernet to send a video file to the personal computer.
To send a video file to the personal computer, install a data storage on the GOT.
The sent video file is temporarily stored in the data storage.

Video camera

GOTPersonal computer Multimedia unit

Video images are 
saved to the CF card.

The video files are sent to the 
personal computer by Ethernet.

Ethernet

1

2
Microphone

Video camera

GOTPersonal computer Multimedia unit

Video images are 
saved to the CF card.

The video files are 
temporarily saved to 
the data storage 
installed to the GOT.

Data 
storage

The video files are sent to 
the personal computer 
by Ethernet.

Ethernet

1

2

3

Microphone
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(b) Displaying the video file list and searching for video files
By using Multimedia Interaction Tool, the received video files and the alarm log files can be combined for list display and 
search.

■4 Multimedia screen
The multimedia screen is for using the multimedia function on the GOT.
The following operations are available on the multimedia screen.
• Displaying and recording images taken by a video camera connected to the multimedia unit
• Playing video files
• Displaying and deleting a video file list
For the operating procedure for the multimedia screen, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(1) How to open the multimedia screen
Open the multimedia screen by using the special function switch.
For the special function switch settings, refer to the following.

➟8.2.9 [Special Function Switch] dialog

■5 Hard copy
To print the hard copy of the multimedia screen, prepare the following beforehand.

(1) Output destination setting for hard copy
To set the output destination for hard copy (data storage), select [Common], and configure the setting in [Hard Copy].
For the setting procedure, refer to the following.

➟9.7.6 [Hard Copy] dialog

■6 Interaction method with a personal computer
For interaction with the personal computer, prepare the following beforehand.

(1) Preparation on the personal computer
(a) Installing and setting the software

Install Multimedia Interaction Tool on the personal computer.
To connect the multimedia unit to Ethernet, also install Multimedia Interaction FTP Service.
After installation, configure the settings for Multimedia Interaction Tool.
For the installation instructions and setting procedure, refer to the following.

➟10.8.5 Multimedia Interaction Tool

(b) Connecting the personal computer to Ethernet
Connect the personal computer to Ethernet.
For the connection method, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

Personal computer

Video file

MMR_20130301_163025.3GP
MMR_20130302_155132.3GP
MMR_20130302_155132.3GP

Alarm log file
Occurred        Comment          Restored
13/03/01     An error occurs!    13/03/01
13/03/02     An error occurs!    13/03/03
13/03/05     An error occurs!    13/03/08
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(2) Preparation on GT Designer3
(a) Configuring the settings for the multimedia function

Configure the settings in the [Multimedia] dialog.
To send video files to the personal computer, enable the following items.

• [Enable the setting of Multimedia]
• [Recording Setting] in the [Recording Setting] tab

[Save to File Server]
• [Before-After Event Recording Setting] in the [Recording Setting] tab

[Enable]
For the setting procedure, refer to the following.

➟10.8.6 [Multimedia] dialog

(b) Communication settings
Configure the communication settings to connect the personal computer to the GOT and the multimedia unit. For the setting 
procedure, refer to the following.

➟10.8.6 [Multimedia] dialog
5.5.4 Configuring the settings for switching the target station No. for monitoring

(c) Setting the user alarm
To send alarm log files of user alarms with recording before and after the event, set the following beforehand.

• Specify the alarm ID set in the [Multimedia] dialog for [Alarm ID] in [User Alarm Observation].
• Select [Save the alarm logs and convert them into Unicode Text/CSV (project common)] in [Alarm Common Setting].
• Select [Save alarm log files] in the [File Save] tab in [User Alarm Observation].

For interaction with the personal computer, Unicode text must be specified as the output format of the user alarm log 
file in [File Save] in [User Alarm Observation].
For how to set the user alarm, refer to the following.

➟9.1.5 Viewing alarm events (Alarm display)

(d) Enabling the FTP server function
To connect the GOT to Ethernet, enable the FTP server function.
For the setting procedure, refer to the following.

➟10.16 Transferring a File between the GOT and Peripheral Device (FTP Server Function)

(3) Preparing a data storage
(a) Preparing a data storage

In the following cases, install the data storage on the GOT.
• Sending a video file from the GOT to the personal computer

When a video file is sent, the G2MMR folder is created in the root folder of the data storage installed on the GOT, 
and the video file is saved in the folder temporarily.
Temporary save is unavailable when no data storage is installed on the GOT. Thus, the video file cannot be sent to 
the personal computer.

• Sending a video file and user alarm data simultaneously from the multimedia unit to the personal computer
User alarm data is stored to the data storage installed on the GOT.
The user alarm data cannot be sent to the personal computer when no data storage is installed.

(b) Connecting the GOT to Ethernet
To send a video file from the GOT to a personal computer, connect the GOT to Ethernet.
To send a video file from the multimedia unit to the personal computer, connect the multimedia unit to Ethernet.
For the connection method, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1
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■7 Setting example of recording before and after the event
Combining the recording before and after the event function and the user alarm enables the GOT to record a video image 
of before and after an alarm and play the video image from the simple alarm display.
The following shows the setting and usage examples for playing the video file recorded when an alarm occurs in simple 
alarm display.

(1) Setting
The following shows the setting for each item.

(a) Synchronizing trigger devices
Set the same device for the following setting items to synchronize occurrence of an alarm with the start of recording before 
and after the event. (X1000)

• [Event Trigger Device] in [Multimedia]
• [Trigger Device] in [User Alarm]

(b) Adding date and time of occurrence
To add the date and the time when an alarm occurs to the name of the video file to be played by using the special function 
switch, set the same device for the following setting items.
(GD501 to GD504)

• [Playback File Time Specification Device] in Multimedia
• [Occurred Date] and [Occurred Time] in [External Notification Information]

An error occurs!
Multimedia 

unit

Play

Error details....

Touch the touch switch.

Occurred  Comment  Restored

Touch the alarm which has occurred.

1. 2. 3. 4.
Simple alarm is displayed. Window screen is displayed. The video file at the alarm 

occurrence is played.

Item Description Reference

[Multimedia]

[Before-After Event Recording Setting] Enabled

➟10.8.6 [Multimedia] dialog

[File Name] ER_MMR

[Event Trigger Device] X1000

[Playback File Time Specification 
Device] GD501 to GD504

[User Alarm Observation]
[Alarm ID] 5 ➟9.1.2 Collecting alarms by 

monitoring devices[Trigger device] X1000

[Simple Alarm Display]
[Alarm ID] 5

➟9.1.5 Viewing alarm events 
(Alarm display)Display setting for [External Notification 

Information]
Alarm ID: GD500 Date: GD501 to 
GD502 Time: GD503 to GD504

[Screen switching 
device(Overlap window 1)] GD500

➟5.2.1 Setting for switching 
screens to be displayed on the 
GOT ([Screen Switching/
Window])

[Window Screen]

Placing the special function switch Special function switch settings
• [Action]: [Multimedia]
• [Initial display screen]: [Multimedia]
• [File Name]: [Multimedia]
• [Add date to playback files]: [Multimedia]

➟8.2.9 [Special Function Switch] 
dialog

[Screen No.] 5

[Screen Type] Window screen
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(c) Setting for [Screen switching device]
To display the window screen with the same number as [Alarm ID] of a generated alarm when touching the simple alarm 
display, set the same device for the following setting items. (GD500)

• Screen switching device
• [Alarm ID] in [External Notification Information]

(2) Description about the action
Step 1 The PLC detects an error and turns on X1000.

The GOT detects that the trigger device of the user alarm and the event trigger device are on. (An alarm 
occurs, and a video image is saved with recording before and after the event.)

Step 2 When an alarm occurs, a user alarm is displayed.
Touching the information of the generated alarm starts writing the following values to the external notification 
device.

• Alarm ID
• Occurrence date
• Occurrence time

Step 3 The value of the alarm ID is written to the screen switching device, and the window screen appears.
Touch the special function switch placed on the window screen.
Touching the special function switch plays the set video file.
The details of the playback file time specification device (date and time of an alarm) are added to the name 
of the video file to be played.

Step 4 The GOT plays the video file of when an alarm occurs on the multimedia screen.

GOT

Video camera

Multimedia 
unit

An error occurs!

Trigger device (X1000): ON
↓

May 23, 2008 15:31:56 
An alarm occurs!

The video image is saved with the recording 
before and after the event.
File name:
ER_MMR_20080525_153156.3GP

PLC

Occurred  Comment  Restored

Event trigger device (X1000): ON
↓

X1000 turns on as 
the error is detected.

Occurred  Comment  Restored

External notification device
(Alarm ID, date and time of occurrence):

GD500 ← 005
GD501 ← 0525 (month and date)
GD502 ← 2008 (year)
GD503 ← 3156 (minute and second)
GD504 ← 0015 (hour)

Multimedia unit

Play

Error details....

The video set to the special function switch is played.

Data of the playback file time specification device
(date and time of alarm occurrence)

File name:
ER_MMR_20080525_153156.3GP
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10.8.5 Multimedia Interaction Tool

Not available to GT2705-V.

■1 How to install the software
(1) Installing procedure

Software to be installed depends on the connection type to Ethernet.

(a) When connecting with the Ethernet interface of the GOT
Install Multimedia Interaction Tool.

(b) When connecting with the Ethernet interface of the multimedia unit
Install Multimedia Interaction Tool and Multimedia Interaction FTP Service.

(c) When one system has the GOT connected by using the Ethernet interface of the GOT and the GOT 
connected by using the Ethernet interface of the multimedia unit
Install Multimedia Interaction Tool and Multimedia Interaction FTP Service.

(1) Software version
Use the same version of Multimedia Interaction Tool and Multimedia Interaction FTP Service.
If the versions are different, Multimedia Interaction Tool does not operate properly.

(2) Precautions for installing and uninstalling the software
Do not install or uninstall Multimedia Interaction FTP Service while Multimedia Interaction Tool is 
running.
Multimedia Interaction Tool may end abnormally or the data may be damaged.

(2) Firewall setting
After installation, set the following software as exceptions in the Windows firewall setting.
Failure to do so prevents video files from being sent to the personal computer.

(a) When sending a video file from the GOT to the personal computer
Set GTMMDataConnector.exe as an exception.

(b) When sending a video file from the multimedia unit to the personal computer
Set GTMMFtpService.exe as an exception.

(c) When sending a video file from the GOT and the multimedia unit to the personal computer
Set GTMMDataConnector.exe and GTMMFtpService.exe as exceptions.
The following shows the setting procedure.

Step 1 Display Windows Firewall by the following operation.
• Microsoft Windows XP: Select [Control Panel] → [Security Center] → [Windows Firewall].
• Microsoft Windows Vista and 7: Select [Control Panel] → [Security] → [Windows Firewall].

The following shows an example of the screen of Microsoft Windows 7. Click the [Change settings] button 
on the displayed dialog and click the [Allow another program…] button.

Multimedia unit

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
10 - 132 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.8 Recording or Playing Images Taken by a Video Camera on the GOT (Multimedia Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
Step 2 Select the software from the program list.
When [GTMMDataConnector.exe] or [GTMMFtpService.exe] is not in the program list, click the [Browse] 
button to specify the path of the program directly.
After selecting, click the [OK] button.

Step 3 The screen returns to the [Windows Firewall] window.
Check that [GTMMDataConnector.exe] or [GTMMFtpService.exe] is selected in [Allowed programs and 
features] and click the [OK] button.
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■2 How to start Multimedia Interaction Tool
Start Multimedia Interaction Tool by the following procedure.

Step 1 From the Windows start menu, select [MELSOFT Application] → [GT MMDataConnector]. *1

*1 Select [All Programs] on the [Start] screen, or select [Start] → [All Programs].
Step 2 Multimedia Interaction Tool starts.

■3 Screen configuration
Multimedia Interaction Tool consists of the following screens.

(1) Main window
In the main window, you can select or display the menu for executing each function of Multimedia Interaction Tool or the 
GOT alarm list.
This screen appears first after Multimedia Interaction Tool is started.
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(2) GOT alarm list window
This window displays alarm data and video files sent from the GOT.
You can play the video file by selecting it from the GOT alarm list.

To display the GOT alarm list window, double-click the GOT alarm list, which is on the left side of the main window.

■4 Settings
To receive the alarm data and video files from the GOT, the setting must be configured in advance.
The following shows the setting instructions.

Step 1 Start Multimedia Interaction Tool and select [File] → [Create new project].
Step 2 The following dialog appears.

Enter the project name to be saved in [Project name] and the path of the folder that saves the project in [Path 
name].
Click the [OK] button to complete the creation of a new project file.

Step 3 Select [Project] → [Create new GOT alarm list].
The following dialog appears.
Enter the name of the GOT alarm list in [Alarm list name] and the path of the folder that saves the list in 
[Folder].
Click the [OK] button to complete the creation of the GOT alarm list.

Step 4 Select [Edit] → [Environment setting].
The following dialog appears.
Enter the setting item, and click the [Close] button.
Before setting, check the following information.

• IP address of the GOT
• FTP user name
• FTP password
• Communication port number of the GOT

For the checking procedure of the FTP user name and the FTP password, refer to the following.
➟10.16 Transferring a File between the GOT and Peripheral Device (FTP Server Function)
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1) [Project]
Click this item to set the display condition of the project.

2) [GOT Alarm]
Displays the GOT alarm list in the tree structure.
Click a GOT alarm list in the tree view to configure the GOT connection setting.
For the details of the setting procedure, refer to the following.

➟(1) Connection setting with GOTs
3) [Project name]

Displays the name of the project file whose environmental settings are to be configured.
4) [GOT communication port No.]

Set the communication port number of the GOT.
The setting range is [0] to [65534].

5) [Use occurred date as second sort key]
When sorting the GOT alarm list by items other than the occurrence date, select ascending or descending order for 
the secondary sort key (occurrence date and time).

6) [Alarm display range (occurred date)]
Set the alarm display range (occurrence date and time) to be displayed in the GOT alarm list.

7) [Alarm display contents]
Select the item to be displayed in the GOT alarm list.

1)
2) 4)

5)

7)

3)

6)
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(1) Connection setting with GOTs

1) [GOT alarm list name]
Displays the name of the GOT alarm list that is being set.

2) [Ethernet (GOT main unit) connection]
Enable the connection setting with GOTs.

3) [Ethernet (multimedia unit) connection]
Enable the connection setting with the multimedia unit.

4) [FTP server settings (common)]
Click this button to check the FTP server setting of Multimedia Interaction FTP Service.
Clicking this button displays the following dialog.

To change the FTP account, click the [Change FTP Account] button.
Clicking the button displays the [Change FTP Account] dialog.

Enter a new FTP user name in [FTP user name] and the password in [Enter FTP password].
Enter the same password as entered in [Enter FTP password] into [Confirm FTP password].
Click the [OK] button to complete the FTP account change.

Item Description

[GOT IP Address] Set the IP address of the GOT. The setting range is [0.0.0.0] to [255.255.255.255].

[FTP user name] Set an FTP user name. Up to 12 alphanumeric characters (a to z, A to Z, 0 to 9) can be set.

[FTP Password] Set an FTP password. Up to 8 alphanumeric characters (a to z, A to Z, 0 to 9) can be set.

[GOT communication timeout (unit: Second)] Set the time required for the communication with the GOT to time out. The setting range is 
[1] to [65535].

[FTP timeout (unit: Second)] Set the time required for the communication by the FTP server function to time out. The 
setting range is [1] to [65535].

Item Description

[MMR IP address] Set the IP address of the multimedia unit.

3)

1)

2)
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■5 Operating procedure
(1) Project file operation
(a) Creating a new project file

To create a new project file, select [File] → [Create new project].
The following dialog appears.
Enter the project name to be saved in [Project name] and the path of the folder that saves the project in [Path name].
Click the [OK] button to complete the creation of a new project file.

(b) Opening a project file
To open a project file, select [File] → [Open project].
The following dialog appears.
Select a program to be opened and click the [Open] button.
The selected project file is opened.

(c) Saving a project file
To save a project file, select [File] → [Save project].
The project file is overwritten.

(2) GOT alarm list operation
The alarm data sent from each GOT is displayed in the GOT alarm list.
Create GOT alarm lists for the number of GOTs connected to the personal computer.

(a) Creating a new GOT alarm list
Select [Project] → [Create new GOT alarm list].
The following dialog appears.
Enter the GOT alarm list name in [Alarm list name] and the path of the folder that saves the list in [Folder].
Click the [OK] button to complete the creation of the GOT alarm list.

(b) Hiding the GOT alarm list
Select the GOT alarm list to be hidden from the GOT alarm tree, and then select [Project] → [Non-display GOT alarm list].
The following confirmation dialog appears.
Click the [Yes] button to hide the GOT alarm list from the GOT alarm tree.
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(c) Redisplaying the GOT alarm list
Select [Project] → [Re-display GOT alarm list].
The following dialog appears.
Enter the hidden GOT alarm list name in [Alarm list name], and click the [OK] button.
The GOT alarm list appears again in the GOT alarm tree.

(d) Deleting the GOT alarm list
Select [Project] → [Delete GOT alarm list].
The confirmation dialog for the GOT alarm list deletion appears.
Click the [OK] button to delete the GOT alarm list.
The deleted GOT alarm list cannot be restored.
Check that deleting the GOT alarm list causes no problem in advance.

(3) Receiving alarm data and video files
Multimedia Interaction Tool can receive alarm data and video files from multiple GOTs connected by Ethernet.
The received alarm data and video files are saved in the personal computer automatically.
You can check the saved data in the GOT alarm list or the distributed video list.

Directory configuration of the project file
The following shows the folder configuration of the project file of Multimedia Interaction Tool.

Folder for GOT alarm list

(Folder for project file)

AlarmList

Folder for GOT alarm list

Movies
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(4) Playing video files
Play the video file in the GOT alarm list by the following procedure.

Step 1 Select the video file to play in the GOT alarm list.
Step 2 Select [Display] → [Play video].

Step 3 QuickTime Player starts.
Click the play button to play the video file.

(5) Searching the alarm data
You can search the alarm data in the GOT alarm list.
Display the GOT alarm list, and select [Edit] → [Search]. The following dialog appears.
Enter the conditions and click the [Search] button. All the displayed items become searching targets.
Selecting [Edit] → [Search next] searches the next alarm data.

Play button
10 - 140 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.8 Recording or Playing Images Taken by a Video Camera on the GOT (Multimedia Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
(6) Editing memos
You can edit memos of the alarm data.
Click the alarm data with the memo to be edited in the GOT alarm list, and select [Edit] → [Edit memo].
The following dialog appears.
Enter texts in [Memo], and click the [OK] button. The entered contents are reflected.

(7) Deleting alarms
You can delete the alarm selected in the GOT alarm list.
Select the alarm in the GOT alarm list, and select [Edit] → [Delete alarms].
The confirmation dialog for the alarm deletion appears.

Select [Backup recording file] when backing up the video files that are associated with the alarms.
At the alarm deletion, video files are saved in the backup folder in the project folder.
Click the [OK] button to delete the alarm.
The deleted alarm cannot be restored.
Check that deleting the alarm causes no problem in advance.

(8) Exporting the GOT alarm list
You can export the GOT alarm list in a CSV file format.
Export the GOT alarm list by the following procedure.

Step 1 Select the GOT alarm list to be exported in the GOT alarm tree.
Step 2 Select [File] → [Export].
Step 3 The following dialog appears.
Step 4 Select the saving destination, and click the [Save] button to start the export of the GOT alarm list.
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■6 Error message
The following shows the error messages of Multimedia Interaction Tool.

Message Cause Measure

Failed to initialize Windows sockets. Initializing the communication processing has 
failed.

• Check that the network cables are connected 
securely.

• Check that the network setting is correct.

Failed to open project "*****".
Any of the project file (*.Mpj), the distributed video 
definition file (*.Mmd), or the alarm information file 
(*.Mai) has been write-protected or deleted.

• Check that writing data to the folders and the 
files in the target project is allowed.

• Check that the folders and the files in the 
target project are not deleted.

Failed to create project "*****".

A new project is not created in the folder specified 
by the user due to the following causes.
• The available space of the hard disk is not 

sufficient.
• The folder specified by the user is write-

protected.

• Check that the hard disk of the personal 
computer has the sufficient available space.

• Check that the folder specified by the user is 
write-protected.

Failed to save project "*****".

The project cannot be saved due to the following 
causes.
• The available space of the hard disk is not 

sufficient.
• The folder specified by the user is write-

protected.

• Check that the hard disk of the personal 
computer has the sufficient available space.

• Check that writing data to the folders and the 
files in the existing project is prohibited.

Failed to create GOT alarm list "*****".

A new GOT alarm list cannot be created due to 
the following causes.
• The available space of the hard disk is not 

sufficient.
• The folder specified by the user is write-

protected.

• Check that the hard disk of the personal 
computer has the sufficient available space.

• Check that writing data to the folders and the 
files in the existing project is prohibited.

Failed to re-display GOT alarm list "*****". The GOT alarm list cannot be created due to a 
creation error of the alarm information file (*.Mai).

• Check that the hard disk of the personal 
computer has the sufficient available space.

• Check that writing data to the folders and the 
files in the existing project is prohibited.

Failed to upload video file "*****" in GOT alarm list 
"*****".

The video file cannot be uploaded because the 
format of the user alarm log file is incorrect at the 
recording before and after the event.

Set the output format of the user alarm log file 
to the Unicode text file.

Project "*****" already exists. The existing project name is entered in the project 
name when a new project is created. Enter another project name.

GOT alarm list "*****" already exists. The existing GOT alarm list name is entered 
when a new GOT alarm list is created. Enter another GOT alarm list name.

GOT alarm list "*****" is already displayed. The displayed GOT alarm list is entered in [Re-
display GOT alarm list]. Select a hidden GOT alarm list.

Invalid path. Please enter again. An invalid path is specified when a new project is 
created. Enter a valid path.

Invalid project name. Please enter again. A project name is entered when a new project is 
created. Enter a project name.

Invalid FTP user name. Please enter user name 
again.

When the FTP account is changed in the 
environmental setting, the FTP user name is not 
entered or 13 or more characters are entered.

Set the FTP user name within 12 characters.

Invalid FTP user password. Please enter 
password again.

When the FTP account is changed in the 
environmental setting, the FTP password is not 
entered or 9 or more characters are entered.

Set the FTP password within 8 characters.

Password entry does not match confirmation 
entry. Please enter password again.

When the FTP account is changed in the 
environmental setting, different passwords are 
entered in [Enter FTP password] and [Confirm 
FTP password].

Enter the same password in [Enter FTP 
password] and [Confirm FTP password].

Cannot connect to GTMMFtpService. Ethernet 
(multimedia unit) connection settings are 
disabled.

The Multimedia Interaction FTP service is not 
installed.

Uninstall or invalidate another FTP server 
software from the personal computer, and 
install Multimedia Interaction FTP Service 
again.

"*****" could not be deleted. Check if the file is in 
use.

The alarm cannot be deleted due to the following 
causes.
• A video file associated with the alarm is being 

played.

Close QuickTime Player.
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"*****" could not be backed up.

The video file cannot be backed up due to the 
following causes.
• The video file is being played.
• The destination folder does not have sufficient 

available space.
• You do not have a writing authority for the 

destination folder.

• Close QuickTime Player.
• Prepare sufficient available space in the 

destination folder.
• Acquire the writing authority for the 

destination folder.

The GOT alarm list "*****" cannot be deleted. 
Check if the file or folder is in use.

The GOT alarm list folder cannot be deleted due 
to the following causes.
• The file in the GOT alarm list folder is being 

executed.
• You do not have the authority to write into the 

GOT alarm list folder.

• Check that the file in the target GOT alarm list 
folder is not being used.

• Acquire the writing authority for the GOT 
alarm list folder.

The version of GTMMFtpService is old. 
GTMMDataConnector is shutting down. Install 
GTMMFtpService version "**" or later.

Failed to start Multimedia Interaction Tool 
because the versions of Multimedia Interaction 
Tool and Multimedia Interaction FTP Service 
were different.

Install Multimedia Interaction FTP Service with 
the same version as Multimedia Interaction 
Tool.

Message Cause Measure
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10.8.6 [Multimedia] dialog

Not available to GT2705-V.
Select [Common] → [Peripheral Setting] → [Multimedia] from the menu to display the setting dialog.

➟■1 [Recording Setting] tab
■2 [Playback/External Notification] tab
■3 [File Server Setting] tab
■4 [Display Setting] tab

1) [Destination I/F]
Set the interface of the GOT.
The following shows the items to be selected.

• [Extend I/F(1st)]
• [Not connected]

Click the [Detail Setting] button to display the detail setting dialog for the multimedia function.

2) [Enable the setting of Multimedia]
Select this item to enable the multimedia function setting.

• [Video Input Signal]
Select the video input signal
The following shows the items to be selected.
• [NTSC]
• [PAL]

• [Video Resolution]
Select the video resolution.
The following shows the items to be selected.
• [640×480]
• [768×576]

• [IP Address]
Set the IP address of the multimedia unit.
The setting range is [0.0.0.0] to [255.255.255.255].

• [Subnet Mask]
Set the subnet mask.
The setting range is [0.0.0.0] to [255.255.255.255].

• [Default Gateway]
Set the default gateway.
The setting range is [0.0.0.0] to [255.255.255.255].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)
1)
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■1 [Recording Setting] tab

Not available to GT2705-V.

1) [Recording Setting]
Configure the setting regarding the video recording.

Item Description

[Recording Mode]

Select the recording mode.
• [Standard]:

Select this item to use the standard mode.
In the standard mode, the record size and the frame rate can be selected.

• [Extended]:
Select this item to use the long-time mode.
In the long-time mode, the record size and the frame rate is fixed.

[Video Input Signal]

Display the current format of the video input signal.
Set the video input signal in the detail setting dialog for the multimedia function.
For the setting procedure, refer to the following.

➟10.8.6 [Multimedia] dialog

[Recording Size]

Select the resolution for recording.
Setting range
When the recording mode is [Standard]: 640×480, 320×240
When the recording mode is [Extended]: 320×240

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

When the recording mode is [Standard] When the recording mode is [Extended]

2)

NTSC format 15

12.5

15

30

12.5

25

VGA (640 × 480) 10 to 240

10 to 900

10 to 450

10 to 450

10 to 900
QVGA (320 × 240)

Recording size         Video input signal       Frame rate (fps)    

PAL format

NTSC format

PAL format

Available recording 
time (minute)

NTSC format 15

12.5
15 to 3000QVGA (320 × 240)

Recording size         Video input signal       Frame rate (fps)  

PAL format

Available recording 
time (sec.)
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2) [Before-After Event Recording Setting]
Configure the setting of the recording before and after the event.
This item can be set only when the recording mode is [Standard].

[Frame Rate]
Select the frame rate for recording.
This item can be selected only when the recording mode is [Standard].
The setting range differs depending on the video input signal and the record size.

[Recording Time]

Set the recording time.
Setting range
When the recording mode is [Standard]: The setting range differs depending on the video input signal, the 
recording size, and the frame rate.
When the recording mode is [Extended]: 15 minutes to 3000 minutes

[Folder Name]

Set the name of the folder that stores the recorded video file.
The folder name can be set only when the recording mode is [Extended].
Use alphanumeric characters and symbols (#$%&'()+-.=@[]^_{}.) for the folder name.
Up to 56 characters (total of the folder name and the file name) are available.

[File Name]

Set the file name when saving the recorded video image as a video file.
• When the recording mode is [Standard]: MR_MMR (Default)

Use up to 44 alphanumeric characters and symbols (#$%&'()+-.=@[]^_{}.) for the file name.
For a video file recorded on the multimedia screen, the date and the time of recording are added to the end 
of the file name.
For the video file recorded by the recording before and after the event, the event occurence date and time 
are added to the end of the file name.
Example) When MMR is set to [File Name] and the video file is recorded on 15:31:56 February 25, 2013

• When the recording mode is [Extended]: SS (Default)
Use alphanumeric characters and some symbols (#$%&'()+-.=@[]^_{}.) for the file name.
Up to 56 characters (total of the folder name and the file name) are available.
When a file is saved, the serial number that indicates the recording order is added to the end of the file name 
automatically.

[Save to File Server]

Sends the recorded video image to a personal computer.
When this item is selected, the [File Server Setting] tab is displayed.
This item can be set only when the recording mode is [Standard].
Configure the connection setting for the personal computer with the GOT and the multimedia unit.

[Recording Loop] When the recording mode is set to [Extended], select this item to continue recording by overwriting old files 
after the recording time.

Item Description

[Enable] Select this item to enable the recording before and after the event.

[Event Trigger Device]
Set the trigger device for starting the recording before and after the event.
➟6.1 Device Settings

[Recording Time]
Set a recording time before and after the event.
• The setting range for a recording time of before the event is [10] seconds to [120] seconds.
• The setting range for a recording time of after the event is [10] seconds to [120] seconds.

[File Name]
Set a name of the file created by the recording before and after the event.
For the restrictions on the file name, refer to the following.

➟■1 [Recording Setting] tab

[Save to File Server]

Select this item to send the recorded video image to a personal computer.
When this item is selected, the [File Server Setting] tab is displayed.
This item can be set only when the recording mode is [Standard].
Configure the connection setting for the personal computer with the GOT and the multimedia unit.

Item Description

MMR_20130225_153156.3GP

Date of recording (February 25, 2013)
(An underline is automatically added.)

Time of recording (15:31:56)

CRT_REC\SS_001.3GP
Number indicating the order of recording
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■2 [Playback/External Notification] tab

Not available to GT2705-V.

1) [Playback Setting]

[Save User Alarm Log File to 
File Server]

Select this item to send an alarm log file to a personal computer at the same time of recording.
Set the alarm ID of the user alarm observation to be stored in [Alarm ID].
When this item is selected, the [File Server Setting] tab is displayed.
This item can be set only when the recording mode is [Standard].
Configure the connection setting for the personal computer with the GOT and the multimedia unit.

Item Description

Item Description

[Playback File Time 
Specification Device]

Set the device for storing a recording date and time of a video file to be played.

➟6.1 Device Settings
Set a word device of 16-bit unsigned BIN for the playback file time specification device.
Contiguous devices for 4 points from the device selected by the user are set.
Year: Second device, Month and date: First device, Hour: Fourth device, Minutes and seconds: Third device. The 
device value of the device is added to the file name when playing video files on the special function switch directly.
Only when [Add date to playback files] is selected in the special function switch setting, the device value is added 
to a file name to be played.
Example) File name of when MMR is set in [File Name] for the video file to be played

For the special function switch settings, refer to the following.
➟8.2.9 [Special Function Switch] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

        MMR_20130225_153156.3GP

The device value of the playback file time 
specification device is added.

(An underline is automatically added.)
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2) [External Notification]

*1 The following table lists the functions of each bit of the word device.

Item Description

[Recording/Playback 
Status Notification 
Device]

Set devices for notifying the status during the playback for video files.
➟6.1 Device Settings
Applicable device: Word device of 16-bit unsigned BIN*1The following shows the difference between the recording 
by the recording switch and the recording before and after the event.

Bit Item Description

b0 Recording status
ON: Recording
OFF: Recording is stopped

b1 Enabling or disabling the recording 
before and after the event

ON: Enabling the recording before and 
after the event
OFF: Disabling the recording before 
and after the event

b2 Status of the recording before and after 
the event

ON: Recording after the event
OFF: Recording before the event

b3 - Use prohibited

b4 to b6 Video playback status

000: Stopping
001: Playing
010: Pausing
Other than the above: Invalid

b7 to b15 - Use prohibited

Recording with the recording switch
Recording status (Recording/playback 
status notification device.b0)

Enabling or disabling the recording 
before and after the event (Recording/
playback status notification device.b1)
Status of the recording before and after 
the event (Recording/playback status 
notification device.b2)

OFF

ON

OFF

OFF

Recording before and after the event Recording before and 
after the event starts.

An event 
occurs.

OFF

ON

OFF

ON

OFF

ON

Recording before 
and after the 
event starts.

The file 
is saved.

Specified 
recording time 
after the event

Specified recording 
time before the event

Length of a recording time to be saved 
before and after the event

Recording status (Recording/playback 
status notification device.b0)

Enabling or disabling the recording 
before and after the event (Recording/
playback status notification device.b1)
Status of the recording before and after 
the event (Recording/playback status 
notification device.b2)

Recording starts Recording stops

Length of a recording time to be saved The file 
is saved.
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■3 [File Server Setting] tab

Not available to GT2705-V.

1) [Connect to the file server with the use of Ethernet in Multimedia Unit]
Select this item to send the video file to the file server by Ethernet from the Ethernet interface built in the multimedia 
unit.

2) [Connect to the file server with the use of Ethernet in GOT]
Select this item to send the video file to the file server by Ethernet from the Ethernet interface built in the GOT.

3) [File Server Setting]

Item Description

[IP Address]
Set the IP address of the personal computer.
The setting range is [0.0.0.0] to [255.255.255.255].

[Port No.]
Set the port number used by the GOT or the multimedia unit.
• For the access to the file server from the multimedia unit, the setting range is [0] to [1024].
• For the access to the file server from the GOT, the setting range is [1024] to [5010] or [5014] to [65534].

[Timeout]
Set the interval for communication to time out.
The setting range is [3] to [120] seconds.

[Retry]
Set the number of retries to be performed when a communication error occurs.
When no response is received after the retries, the communication times out.
The setting range is [0] time to [10] times.

[Retry Interval]
Set the interval of retries to be performed when a communication error occurs.
The setting range is [0] to [300] second(s).

[FTP Login Name]
Set the login name for the file server.
This item can be set only when [Connect to the file server with the use of Ethernet in Multimedia Unit] is 
selected.

[FTP Password]
Set the password for the file server.
This item can be set only when [Connect to the file server with the use of Ethernet in Multimedia Unit] is 
selected.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

3)

When connecting the multimedia unit to Ethernet When connecting the GOT to Ethernet
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■4 [Display Setting] tab

Not available to GT2705-V.
Configure the setting to display the image taken by a video camera on the user-created screen.

1) [Display video input image]
Select this item to display the video image on the user-created screen.

2) [First Device]
Set a start device of the devices to be used.
When the first device is set, the subsequent devices are automatically set in the [Device] row in the video setting list.

3) Video setting list

*1 The following table lists the functions of each bit of the word device.

Item Description

[Display Control Common]

Set a device for the video window display.
The values of the device for the video window display are processed as 16-bit binary values.
The device specified for [Display Control Common] stores the data as indicated below.

Turning on/off the bit devices controls the operation of the multimedia screen.*1

[Transparent Color]
• [0 to 65535], [0(Black) to 255(White)]

Specify the transparent color for the transparent processing.
➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device

[Clip]

• [X Position]
Specify the X coordinate to display a video image when the clip mode is used.

• [Y Position]
Specify the Y coordinate to display a video image when the clip mode is used.

• [Width]
Specify width of a clip video image.

• [Height]
Specify height of a clip video image.

[Video Window]

• [CH No.]
Specify the channel No. for a video image to be displayed on the video window.
Only one channel can be used for the multimedia function.

• [Size]
Specify the display size of the video window.
The following shows the setting range for the display size.
0: 100%, 1: 50%, 2: 25%
When the display size of the video window is changed by touching the window, the value of the set 
device remains unchanged.

• [X Position]
Specify the X coordinate of the video window.

• [Y Position]
Specify the Y coordinate of the video window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
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Bit number Description Bit status Remarks

b0 Selecting the full mode or clip 
mode

ON: Selects the clip mode.
OFF: Selects the full mode.

Valid when the video window is 
displayed.
Bit status can be changed while 
the video window is displayed.

b1 Selecting the screen for placing 
the video window

ON: Selects the overlap window 1.
OFF: Selects the base screen.

Transparent processing is 
executed automatically when b1 is 
ON.

b2 Selecting the transparent 
processing

ON: Executes the transparent 
processing.
OFF: Does not execute the 
transparent processing. ➟10.6.4 ■9 Transparent 

processing

b3 Selecting how to specify the 
transparent color

ON: Makes colors other than the 
specified color transparent.
OFF: Makes the specified color 
transparent.

b4

Selecting whether the display size 
of the video window is changed or 
not when the video window is 
touched

ON: Does not change the size.
OFF: Changes the size.

Valid when the video window is 
opened. Bit status can be changed 
while the video window is 
displayed.

b5 Selecting a motion video or still 
image

ON: Selects a still image.
OFF: Selects a motion video.

When this bit is turned on with 
other bits at the same time, the 
contents of other bits are 
disregarded. (b5 has priority.)
➟10.6.4 ■7 Displaying a still 

image

b6

Selecting display priority for video 
windows (When b2 (selecting 
transparent processing) is OFF.)

ON: Displays the video window 
over the overlap window or test 
window.
OFF: Displays the video window 
behind the overlap window or test 
window.

Valid when the video window is 
opened.
Bit status can be changed while 
the video window is displayed.

Selecting transparent processing 
target screen (When b2 (selecting 
transparent processing) is ON.)

ON: Base screen only
OFF: Base screen and overlap 
window 1 and 2

-

b7 to b15 Use prohibited - -
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10.8.7 Precautions

Not available to GT2705-V.
This section explains the precautions for using the multimedia function.

■1 Precautions for hardware
(1) Data storage of the GOT

To interact the GOT with a personal computer, reserve sufficient available space of the data storage of the GOT.
Video files are stored in the data storage of the GOT temporarily.
If the available space of the data storage is insufficient, the video files cannot be sent to the personal computer.

(2) CF card of the multimedia unit
(a) Format type

A CF card to be installed in the multimedia unit should be formatted in FAT32.
Installing a FAT16 formatted CF card may cause the following problems.

• Reading, writing, or saving a video file reqiures time.
• A video file temporarily looks as if it is stopped while being played.

(b) Operation during access to a CF card
After the CF card access switch of the multimedia unit is turned on, the multimedia unit checks the CF card status.
Operations on the multimedia screen may not be performed properly during the check.
Perform the operations on the multimedia screen after the CF card access LED turns off.

(c) Number of video files
Up to 512 video files can be stored in the CF card.
When 512 or more video files are stored, some video files are not displayed on the multimedia screen.
In addition, in the following cases, some video files may not be displayed on the multimedia screen even when 512 or less 
video files are stored.

• A video file with a long file name exists.
• A video file in which two-byte characters are used for the file name exists.
• Data other than video files exists in the CF card.

(d) Unavailable character strings
Do not use two-byte characters for the path and the file name.
Failure to do so may operate the multimedia unit incorrectly.

(3) Software version of the multimedia unit
The software version must be 03.02.00.** or later.
The functions described in this manual are compatible with the multimedia unit having software version 03.02.00.** or 
later.
For how to check and update the software version of the multimedia unit, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(4) Ethernet interface of the multimedia unit
The Ethernet interface of the multimedia unit is only for the communication with Multimedia Interaction Tool.
To connect the GOT to Ethernet, use the Ethernet interface built in the GOT.

■2 Precautions for drawing
(1) Displaying the video window, RGB screen, and multimedia screen

The simultaneous display of the video window, RGB screen, and multimedia screen is not available.

(2) Displaying a window with transparency

If a window with transparency is placed on the multimedia screen, the multimedia screen is invisible.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Graphic Ver.2
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■3 Precautions for use
(1) Display of a video image
(a) If a video signal is not input to the specified channel due to cable disconnection or power-off of a video 

camera, a video image is not displayed.
(b) A video image may be given in still image or disappear temporarily when the hard copy function is 

executed or when a system message is displayed or cleared.
(c) A video image may be disturbed or stopped depending on the setting for [Horizontal] or [Vertical] for 

the utility (video display setting).
(In this case, the normal display will be restored by changing the settings to default values.)
Whether or not such a problem occurs depends on equipment such as a video camera.
Use setting values that allow normal video display
For the operating procedure for the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(2) Video input signal setting
Set a video input signal according to an output format of the video camera to be connected as shown below.
If the setting is different, some video images may not be displayed correctly.

(3) Playing video files during the recording
A video file cannot be played while a video image is being recorded.
Play the video file after the recording is finished.

(4) Installing Multimedia Interaction FTP Service
To connect the GOT to a personal computer from the multimedia unit, Multimedia Interaction Tool and Multimedia 
Interaction FTP Service must be installed.
For how to install Multimedia Interaction FTP Service, refer to the following.

➟10.8.5 Multimedia Interaction Tool

10.8.8 Relevant settings

Not available to GT2705-V.
Set the relevant settings other than the specific settings for the multimedia function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
➟12.1.3 GOT special register (GS)

Output format of video camera Video input signal setting

NTSC format NTSC

PAL format PAL

EIA format NTSC

CCIR format PAL

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Enabling or disabling notification of the amount of usage of the CF card and the number of video files in the card in the 
multimedia unit GS522.b1

Notifying the amount of usage of the CF card or the number of video files in the card in the multimedia unit GS1022.b0 to GS1022.b7
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.8 Recording or Playing Images Taken by a Video Camera on the GOT (Multimedia Function)

10 - 153



10.9 Using an External I/O Device on the GOT (External I/O Function and 
Operation Panel Function)

Not available to GT25-W, GT2505-V, and GT25HS-V.

10.9.1 Overview of the external I/O function and the operation panel function

Not available to GT25-W, GT2505-V, and GT25HS-V.

■1 External I/O function

Not available to GT25-W, GT2505-V, and GT25HS-V.
This function enables you to input/output signals from/to an external device.

■2 Operation panel function

Not available to GT25-W, GT2505-V, and GT25HS-V.
This function enables you to input data by using an operation panel. (For example, the touch input, numerical input, and 
screen switching.)
When you use GT SoftGOT2000, use the keyboard of the personal computer.
For the operations with the keyboard on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

A maximum of 16 points 
of external outputs are 
available.

A maximum of 128 
points of external 
inputs are available.

Input Output
GOTA push button, an operation 

panel, or other devices
Lamp, relay

External 
I/O unit

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

A 1254

348B

A 1254

348B

External 
I/O unit

Pressing the key to switch 
the screen from Screen 1 
to Screen 2

Switching Screen 1 
to Screen 2

An operation panel
Displaying Screen 1
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10.9.2 Specifications of the external I/O function and the operation panel function

Not available to GT25-W, GT2505-V, and GT25HS-V.

■1 System application (extended function)
To use the external I/O function and the operation panel function, a system application (extended function) of [External I/O 
/ Operation Panel] is required.
Selecting [Destination I/F] in the [External I/O / Operation Panel] dialog incorporates the application into the package data 
automatically.

➟10.9.4 [External I/O / Operation Panel] dialog

■2 Number of external I/O function settings for one project
One external I/O function setting is available for one project.

■3 Specifications of the external I/O
Externally input signals are stored in the GOT internal devices.
The values in the GOT internal devices are output to the outside as output signals.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])
12.1.1 GOT bit register (GB)
12.1.3 GOT special register (GS)

The external I/O function supports the GOT internal devices and the System signals as shown below.

*1 To enable the 128-point input, turn on GS517.b0 (External I/O Function Notification/External I/O Control Function).

(1) When the 128-point input is used for the external I/O function
If input signals X0 to XF turn on, the corresponding GOT internal devices (GB30 to GB37 and GB50 to GB57) also turn 
on. (The 128-point input is disabled, and GS517.b0 turns off.)

(2) When the external signal output is controlled with the external I/O function
Do not simultaneously perform the following two operations: specifying the device for [External I/O Function Output 
Information] and writing the output value into GB10 to GB25. If doing so, the signals may not be output properly to the 
external device.

■4 Specifications of the operation panel
(1) Screens operable with the operation panel function

The operation panel function is usable for the following screens.
• User-created screen
• Log-in screen (Operator authentication)
• Password change screen (Operator authentication)
For the key codes for the operation panel keys, which are usable on the log-in screen (operator authentication) and the 
password change screen (operator authentication), refer to the following.

➟10.9.3 How to use the external I/O function and the operation panel function
The [OK] button and the [Cancel] button, which are in the messages on the GOT, operate with the following operation 
panel keys.
• [OK] button: [Enter] key, [Y] key, and [y] key
• [Cancel] button: [ESC] key, [N] key, and [n] key
For using the operation panel function on GT SoftGOT2000, use the function keys on the keyboard of the personal 
computer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item GOT internal device System Information

Input signal (X0 to X7) GB30 to GB37 [External I/O Function Input Information1] The signals 
correspond to the bit numbers (b0 to b7) of the devices.

Input signal (X8 to XF) GB50 to GB57 [External I/O Function Input Information2] The signals 
correspond to the bit numbers (b0 to b7) of the devices.

Input signal (X0 to XF) when the 128-
point input is enabled*1

GS658 to GS665 The signals correspond to the bit 
numbers (b0 to b15) of the devices. -

Output signal (Y0 to YF) GB10 to GB25
[External I/O Function Output Information] The signals 
correspond to the bit numbers (b0 to b15) of the 
devices.
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(2) Operation of the operation panel function
The keys operate according to the set actions on any screens displayed on the GOT.
When you press any touch switch on the GOT and any operation panel key/function key simultaneously, the operations 
are executed in order of detection.

10.9.3 How to use the external I/O function and the operation panel function

Not available to GT25-W, GT2505-V, and GT25HS-V.

■1 System configuration
(1) System configuration of the external I/O device

The following shows the system configuration of the external I/O device.

*1 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*2 The 24 V DC power must be supplied for the external I/O unit.
When the power supplied to the external I/O unit cuts off in the operation, the operation panel becomes disabled.
To use the operation panel again, supply the power to the external I/O unit and reset the GOT.

*3 When using the connector/terminal block converter module, you can input signals of up to 64 points.
*4 The model of the connector/terminal block converter module depends on the I/O equipment and the operation panel you use.

For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 

Version1
*5 To start the GOT, turn on the external power supply for the external I/O unit, then power on the GOT.

When the external power supply is shut off, a system alarm occurs.
When a system alarm occurs, signals cannot be input or output.
Turn off and then on the GOT or reset the GOT.
(The GOT reset switch does not operate when the bus connection is used.)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Name Connection cable 1
Connector/terminal 

block converter 
module*2*3

Connection cable 2
GOT*5

Option GOT model

General input device (such as 
a push button)
Operation panel
General output device (lamp, 
relay)

Preparing connection 
cables by each user*1 *4 Preparing connection 

cables by each user*1

GT15-DIO

GT27, GT25
GT15-DIOR

GOT

Connection cable 2

Connection cable 1
Connector/
terminal block 
converter module

General I/O device
(such as a 

push button)

General output 
device

(lamp, relay)

Operation panel

Connection cable 1

DC power supply
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(2) System configuration of the operation panel
Since GT SoftGOT2000 uses a keyboard, GT SoftGOT2000 requires no connection to an operation panel.
The following shows the system configuration of the operation panel.

*1 For how to create a cable, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 
Version1

*2 The 24 V DC power must be supplied for the external I/O unit.
When the power supplied to the external I/O unit cuts off in the operation, the operation panel becomes disabled.
To use the operation panel again, supply the power to the external I/O unit and reset the GOT.

*3 To start the GOT, turn on the external power supply for the external I/O unit, and then turn on the GOT.
When the external power supply is shut off, a system alarm occurs.
When a system alarm occurs, signals cannot be input or output.
Turn off and then turn on the GOT, or reset the GOT.
(The GOT reset switch does not operate when the bus connection is used.)

■2 Settings of the operation panel keys and the function keys
You can assign actions and key codes to the operation panel keys and the function keys.

(1) Operation setting
One or more actions can be assigned to each operation panel key or function key as shown below.

*1 he order of the actions, excluding the data change and the key code, can be changed on the [Action] tab.

Name Connection cable
GOT*3

Option GOT model

Operation panel Preparing connection cables by each user*1*2
GT15-DIO

GT27, GT25
GT15-DIOR

GOTOperation panel

Connection cable

DC power supply

Data change   : 1
Key code    : 16
Word set    : 20
Set    : 20
Reset    : 20
Alternate    : 20
Momentary   : 20
Base screen switching  : 1
Overlap window1   : 1
Overlap window2   : 1
Overlap window3   : 1
Overlap window4   : 1
Overlap window5   : 1
Superimpose window1  : 1
Superimpose window2  : 1
Station No. switching  : 9
Dialog window   : 1
 

Total    : 135

Order of action
excution priority

for multiple
actions*1

GT27,GT25, GT SoftGOT2000

High priority

Low priority
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(2) Key code
You can assign the key codes used for the objects. (Up to 16 key codes are settable for one operation panel key or 
function key.)
• Key codes for inputting alphanumeric characters (Numerical input, text input)
• Key codes for operating the object function

➟8.2 Placing a Touch Switch

(3) Other key codes
You can operate the following screens by assigning the key codes to the operation panel keys or function keys.
• Log-in screen (Operator authentication)
• Password change screen (Operator authentication)
The following shows the key codes usable on the screens.

(a) Log-in screen and password change screen

*1 For the key codes for numerical values and characters, refer to the following.

➟8.2 Placing a Touch Switch

■3 Setting procedure
Step 1 Connect the GOT to the external I/O device or the operation panel.

➟■1 System configuration
Step 2 In the [External I/O / Operation Panel] dialog, configure the settings for the external I/O function and the 

operation panel function.

➟10.9.4 [External I/O / Operation Panel] dialog
Step 3 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 4 Operate the external I/O device or the operation panel.

Key code(h) Specifications

0008h Delete the rightmost character and shift the entire 
characters to the right by one character.

000Dh Input the password.

001Bh Cancel

0030h to 0039h, 0041h to 005Ah, 0061h to 007Ah Input a numerical value and a character.*1

0088h Delete a numerical value and a character being input.

0090h Move cursor to the right inside object.

0091h Move cursor to the left inside object.

0092h Switch character input mode (Value).

0093h Switch character input mode (Capital letter).

0094h Switch character input mode (Small letter).
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10.9.4 [External I/O / Operation Panel] dialog

Not available to GT25-W, GT2505-V, and GT25HS-V.
Select [Common] → [Peripheral Setting] → [External I/O /Operation Panel] from the menu to display the setting dialog.
Set the actions and key codes to the operation panel keys or function keys.

1) [Destination I/F]
Select a destination interface.
The following shows the items to be selected.

• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

2) [Operation Panel Setting]

Item Description

[Use Operation Panel] Enables the operation panel function setting.

[Display Type]

Select the display type.
• [Key Code] button

Displays the key codes on the key buttons where the key codes are assigned.
Example) [0042]

• [Action] button
Displays [*] on the key buttons where the actions are assigned.

• [Clear] button
Clears the setting.

[Panel Key Setting]

To the input signals, assign the actions when the signals turn on and the key codes.
Clicking the input signal button displays the [Action/Key Code Setting] dialog.
Set the actions, trigger conditions, and key code.
The key buttons correspond to the operation panel input signals (X000 to X07F) respectively.
Make sure to configure the proper action setting for each operation panel key button.

➟10.9.5 [Action/Key Code Setting] dialog
Clicking the To Right Panel button or the To Left Panel button switches the input signals (+00 to +07 ←→ 
+08 to +15).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)
To Right Panel button

To Left Panel button

Screen showing the left 
panel when GT27 is selected 
in the GOT type setting

Screen showing the right panel 
when GT27 is selected in the 
GOT type setting

Screen showing the panel when 
GT SoftGOT2000 is selected in the 
GOT type setting

3)

The setting is 
configured for 
input signal X010.

The setting is 
configured for 
input signal X005.
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[Initialize]

Select the operation panel setting according to the key arrangements of the KANADEN CORPORATION 
operation panel and A8GT-TK.
• [FP5-MD41-* Compatible] button

Sets the key arrangement and key settings of the KANADEN CORPORATION operation panel.
• [A8GT-TK Compatible] button

Sets the key arrangement and key settings of the A8GT-TK.
The operation panel setting is initialized according to the key arrangements of the KANADEN 
CORPORATION operation panel and the A8GT-TK numeric keypad panel.

Item Description

X0

X1

X2

X3

X4

X8

X9

XA

XB

XC

X10

X11

X12

X13

X14

X18

X19

X1A

X1B

X1C

X20

X21

X22

X23

X24

X28

X29

X2A

X2B

X2C

X30

X31

X32

X33

X34

X38

X39

X3A

X3B

X3C

X5

X25

X6

X26

X7

X27

XD

X20

XE

X2E

XF

X2F

X15

X35

X16

X36

X17

X37

X1D

X3D

X1E

X3E

X1F

X3F

Arrangement of input signal

Key arrangement

F1

A

H

O

V

F2

B

I

P

W

F3

C

J

Q

X

F4

D

K

R

Y

F5

E

L

S

Z

F6

F

M

T

SP

F7

G

N

U

SP

8

5

2

0

9

6

3 .

GO

7

4

1

Scroll
up

Scroll
down

Pre.

Next

Clear

Set

MELSEC/A8GT-TK

X0 X8 X10

X18 X20 X28

X30 X38 X39

X3A X15 X35

XD

X2D
X25 X5

X2C X37 X3F

X2F

X7

X26

X6

X1F

XF

X2E

XE

X27

X17

X36

X16

Arrangement of input signal Key arrangement

MELSEC/A8GT-TK

F1 F2 F3

F4 F5 F6

F7 F8 F9

F10 SCROLL
UP

SP BS

0

1

4

7

2

5

8

3

6

9

SCROLL
DOWN

KANADEN operation panel

A8GT-TK numeric keypad panel
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3) [Function Key Setting]
Appears when GT SoftGOT2000 is selected in the GOT type setting.

10.9.5 [Action/Key Code Setting] dialog

Not available to GT25-W, GT2505-V, and GT25HS-V.
Configure the operation setting and the trigger conditions for the operation panel keys or function keys.

➟■1 [Action] tab
■2 [Trigger] tab

■1 [Action] tab
Configure the operation setting (actions and key codes).
For the details of the operation setting, refer to the following.

➟8.2 Placing a Touch Switch

1) [Action List]
Assign the actions to the operation panel key or function key.
The set action details are listed.
The setting method and action details (including bit and word) are the same as those for the touch switch.

Item Description

[Use Function Key] Enables the setting of the function keys used for GT SoftGOT2000.

[Display Type]

Select the display type.
• [Key Code] button

Displays the key codes on the key buttons where the key codes are assigned.
Example) [0042]

• [Action] button
Displays [*] on the key buttons where the actions are assigned.

• [Clear] button
Clears the setting.

[Function Key Setting]

To the function keys, assign the actions when the keys turn on and the key codes.
Clicking the function key button displays the [Action/Key Code Setting] dialog.
Set the actions, trigger conditions, and key code.
The buttons correspond to keys F1 to F8 of the keyboard.
In combination with the Shift key and the Ctrl key, up to 32 patterns are available.
Make sure to configure the proper action setting for each function key.

➟10.9.5 [Action/Key Code Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

6)

1)

8)
9)

10)
11)

2)

3)
4)
5)
7)
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2) [Add Action]

3) [Utilize] button
Select an action from [Action List] and then click the [Utilize] button to copy the action to [Action List].

4) [Edit] button
Select an action from [Action List] and then click the [Edit] button to enable you to edit the action setting.

5) [Delete] button
Select an action from [Action List] and click the [Delete] button to delete the action.

6) [User ID for a key input]
Set the ID to specify the object for the key code input.
The setting range is [0] to [65535].

7) [Change Order] button
Change the order of the actions.

8) [Security]
When using the security function, set the security level.
The setting range is [1] to [15].
When not using the security level, set the level to 0.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
9) [Simultaneous Press]

Select this item to disable the simultaneous press and to set the key status having a higher priority.
The following shows the setting items to be selected.

• [ON Priority]
• [OFF Priority]

10) [User ID]
Enables the user ID setting.
The setting range is [0] to [65535].
When the user ID is set, you can identify the used operation panel key with the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
When multiple objects are set on the same screen editor, the target object may not operate.
To make sure that the target object operates, match the user ID with the user ID of the target object.

11) [Operation Log Target]
Targets the object for the operation log.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])

Item Description

[Bit] button Set the ON and OFF operations of the bit device.

[Word] button Change the word device value.

[Screen Switching] button Configure the setting of switching base screens and window screens for the operation 
panel key or function key.

[Station No. Switching] button Configure the setting of the station No. switching function for the operation panel key or 
function key.

[Key Code] button Configure the setting of the key code for the operation panel key or function key.

[Key Window Display] button Set the display position of the key window.
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■2 [Trigger] tab
Set the trigger conditions so that the operation panel keys or the function keys operate.
For the details of the trigger conditions, refer to the following.

➟5.3Setting the Utility Function ([GOT Setup])

1) [Trigger Type]
Select a trigger condition for the operation panel key or function key.
The following shows the items to be selected.

• [Ordinary]
• [ON]
• [OFF]
• [Range]
• [Bit Trigger]

For the details of each item, refer to the following.
➟6.2.2 Setting Trigger Types

2) [Repeat the operation while the switch is pressed]
Repeats the set actions while the operation panel key or the function key is pressed.

1)

2)
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10.9.6 Relevant settings

Not available to GT25-W, GT2505-V, and GT25HS-V.
Set the relevant settings other than the specific settings for the external I/O function and the operation panel function as 
required.
The following shows the functions that are available by the relevant settings.

■1 GOT environmental settings [Screen Switching/Windows]
Select [Common] → [GOT Environmental Setting] → [Screen Switching/Windows] from the menu.

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

■2 GOT environmental settings (System information)
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■3 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Setting the screen switching timing when touching the Go To Screen switch (OFF 
synchronous, ON synchronous) [Operation Timing]

Function Setting item

Outputting signals to the external device when the external I/O function is used. (Read 
device) [External I/O Function Output Information]

Notifying the input signals from the external device or no power supply when the external 
I/O function is used. (Write device)

[External I/O Function Input Information1], [External I/O 
Function Input Information2]

Function Setting item

Notifying the input signals from the external device or outputting the signals to the external 
device when the external I/O function is used. GB10 to GB25, GB30 to GB37, GB50 to GB57

Notifying the input status when 128 signals are enabled to be input with the external I/O 
function GS658 to GS665

Enabling or disabling 128 signals to be input with the external I/O function. GS517
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10.10 Displaying the GOT Screen on an External Display (Video Output 
Function)

Not available to GT2705-V.

10.10.1 Overview of the video output function

Not available to GT2705-V.
This function enables you to output the GOT screen to a commercially available display.

• Outputting the screen displayed on the GOT
You can monitor the PLC status on the GOT and display the monitoring result on a big screen in a factory.

• Outputting an overlap window
The specified overlap window can be output to the display and used for the ANDON function.
When an overlap window is output to the display, the window is not displayed on the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Outputting the screen on the GOT to a commercially available display

Outputting overlap window 1 to the display

Overlap window 1
Line

A 1254

B 348

C 1254

D 348

Line
A 1254

B 348

C 1254

D 348
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10.10.2 Specifications of the video output function

Not available to GT2705-V.

■1 Required version of BootOS
The BootOS version depends on the option to be used and the screen to be output to the display.
For information on how to install the BootOS, refer to the following.

➟4.3.2 Transferring data

(1) Option to be used
To use GT27-ROUT, install BootOS version N or later on the GOT.
To use GT27-VHOUT, install BootOS version AK or later on the GOT.

(2) Screen to be output to the display
To output an overlap window, install version AW or later of BootOS on the GOT.

■2 Required version of the standard system application
To output an overlap window to the display, install a standard system application version 01.39.*** or later to the GOT.
For how to check the version of the standard system application, refer to the following.

➟GOT2000 Series User's Manual (Utility)

■3 Overlap window to be output to the display
Select an overlap window to be output to the display in the [Environmental Setting] window ([Screen Switching/
Windows]).

➟5.2.1 ■5 [Screen Switching/Window]
The selected overlap window is not displayed on the GOT.

(1) Disabled functions
The following functions set for the selected overlap window will be disabled.

• Assignment to a system window
• Display position specification
• Display order specification
• Touch operation on the screens behind the overlap window
• Title bar display
• Automatic closing of the overlap window when the base screen is switched

(2) Switching the screen
To switch the screen displayed on the overlap window, use a screen switching device or Go To Screen switch.

➟5.2.1 ■5 [Screen Switching/Window]
8.2.7 [Go To Screen Switch] dialog

When 0 is set to the screen number, a black screen is output to the display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Resolution of the screen to be output to the display
The screen is output to the display in the GOT (output source) screen resolution.
If an overlap window smaller than the GOT screen is output, space (black area) appears around the overlap window.

When the screen is changed on the display, the screen, is resized according to the GOT screen resolution.
Since the window has extra space in some cases, the screen may not be resized as intended.
Example) Maximizing the screen on the display to the size of the display

You are recommended to create an overlap window to be output according to the GOT screen resolution.

■5 Display on the external display showing a dialog window when the GOT is in screen saver 
mode

When the GOT is in screen saver mode, the external display will not enter screen saver mode.
When the GOT displays a dialog window, the display on the external display differs depending on what screen is output 
to the display.

• Screen displayed on the GOT
The external display displays the screen showing a dialog window.

• Overlap window
The external display displays the specified overlap window only.

Line
A 1254

B 348

C 1254

D 348

Red line: GOT screen resolution
Red line: GOT screen resolution
Black area: Extra space that shows the GOT screen resolution

Displaying an overlap window created 
in the same size as the GOT screen

Displaying an overlap window created smaller 
than the GOT screen

Line
A 1254

B 348

C 1254

D 348

Line
A 1254

B 348

C 1254

D 348

Line
A 1254

B 348

C 1254

D 348

Maximizing the window 
to the size of the display

Displaying an overlap window created smaller 
than the GOT screen

Line
A 1254

B 348

C 1254

D 348

Line
A 1254

B 348

C 1254

D 348

Maximizing the window 
to the size of the display

Displaying an overlap window created 
in the same size as the GOT screen

The window without extra space will be 
expanded to full-screen.

The window with extra space will not be 
expanded to full-screen.
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10.10.3 How to use the video output function

Not available to GT2705-V.

■1 System configuration

*1 The cable and its maximum length vary depending on the external display specifications.
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT Works3 

Version1
*2 Not available to GT2705-V.
*3 The maximum cable length varies depending on the cable specifications.

■2 Setting procedure
Step 1 Connect an external display to the GOT.

➟■1 System configuration
Step 2 In the [HDMI/RGB Output] dialog, set [Destination I/F].

➟10.10.4 [HDMI/RGB Output] dialog
Step 3 To output an overlap window to the external display, select the overlap window in the [Environmental 

Setting] window ([Screen Switching/Window]).

➟5.2.1 ■5 [Screen Switching/Window]
Step 4 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 5 Display the GOT screen on the external display.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Signal type
External display Connection cable Maximum 

cable 
length

GOT Number of 
connectable monitorsModel Model Option GOT model

TMDS HDMI-certified display HDMI-certified cable *3 GT27-
VHOUT

GT27*2 One display for one 
GOT

Analog 
RGB

Display that supports VESA-compliant 
GOT screen resolution
For the supported scanning frequency, 
refer to the following.

➟GOT2000 Series RGB Output Unit 
User's Manual

GT15-C50VG (5m) or 
Preparing connection 
cables by each user*1

*1

GT27-
ROUT, 
GT27-
ROUT-Z

External display GOT

Connection cable
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10.10.4 [HDMI/RGB Output] dialog

Not available to GT2705-V.
Select [Common] → [Peripheral Setting] → [HDMI/RGB Output] from the menu to display the setting dialog.

1) [Destination I/F]
Set the interface of the GOT.
The following shows the items to be selected.

• [Extend I/F(1st)]
• [Not connected]

10.10.5 Precautions

Not available to GT2705-V.
This section explains the precautions for using the video output function.

■1 Precautions for use
(1) Changing the screen to be output to the display

When selecting or deselecting [Output a window screen via HDMI/RGB] in the [Environmental Setting] window ([Screen 
Switching/Window]) for a project and writing the project data to the GOT, the GOT restarts.

(2) Operation on the display
Even if the display supports touch operation, the objects on the display are inoperable.

(3) Vertical display
If you set vertical installation to the GOT and create a screen, use the display vertically.

■2 Precautions when outputting an overlap window
(1) Display when transitioning a GOT screen to a screen other than a user-created screen

In this case, [Monitoring has been stopped.] appears on the display.
The screen to be displayed on the display at screen transition can be changed using GS633.

➟12.1.3 GOT special register (GS)

(2) Display when restarting monitoring
When transitioning the GOT screen from a screen other than used-created screen to a user-created screen and restarting 
monitoring, the following objects will be deleted.
The display before transitioning the screen will not be retained.

• Scatter Graph
When [Store Memory] is deselected and [Graph Type] is [Sample]
When [Store Memory] is deselected, [Graph Type] is [Batch], and [Display Mode] is [Locus]

• Parts Display
When [Display Mode] is [Overwrite]

• Parts Movement
When [Display Mode] is [Locus]

• Figures freely drawn using the object script

(3) Overlap window when GT Simulator3 is used
An overlap window to be output to the display appears as a normal overlap window in GT Simulator3.
However, the title bar is not displayed. Configure a method to close the window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Overlap window when the SoftGOT-GOT link function is used
The overlap window on the display is not displayed when the SoftGOT-GOT link function is used.
Also, the background function set for the overlap window does not run.

10.10.6 Relevant settings

Not available to GT2705-V.
Set the relevant settings other than the specific settings for the video output function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Available only when an overlap window is output to the display.
Setting a screen to be displayed on the display at transition of a GOT screen to a screen 
other than a user-created screen

GS633

Setting the screen number of a screen other than an overlap window to be output to the 
display by setting 1 to GS633 GS634
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10.11 Outputting the Collected Data as a Report (Report Function)

10.11.1 Overview of the report function

The report function outputs the collected data as a report.
The settings of a report screen determine the data to be collected and the page layout of a report.

A report is output to a printer or file.

➟10.11.2 Specifications of the report function
10.11.3 How to use the report function
10.11.4 Precautions
10.11.5 [Report Setting] dialog
10.11.6 [Edit Page Header/Page Footer] dialog
10.11.7 [Header/Footer/Repeat] dialog
10.11.8 [Printer] dialog
10.11.9 Relevant settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2018/7/1 17:38:04

REPORT

REPORT

2018/7/1 17:38:04

REPORT

1 2

ITEM X Y ITEM X Y ITEM X Y

LINE A

LINE B

100 100

150 300

100 100

300 50

LINE A

LINE B

150 300

450 600

300 50

150 100

Header

Footer

Body, 
Repeat line

Report screen

Header

Footer

Body, 
Repeat line

Report sample

Page 1 Page 2

Report

Output to a printer

Output to a file

Printer

Data storage 
or file server

Output to a printer using 
the file print function

Printer
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10.11.2 Specifications of the report function

■1 System application (extended function)
To use the report function, the following system applications are required.

To use the function on GT21, GT SoftGOT2000, or GS21, the applications are not required.

■2 Required version of BootOS
To use an Ethernet printer (ESC/P-R), install version AJ or later of BootOS on the GOT.

➟4.3.2 Transferring data

■3 Hardware
Whether a data storage or file server must be connected to the GOT depends on the settings made in the [Screen 
Property] dialog for a report screen.

➟2.7.3 ■2 [Action] tab
○: Required, ×: Not required

*1 A temporary file is saved only into the data storage.

■4 Specifications of a report screen
The following shows the specifications of a report screen.
For report samples and the items to be output, refer to the following.

➟10.11.2 ■5 Report samples and the items to be output to a report

(1) Maximum number of report screens in one project
Up to 99 report screens are settable for one project.

(2) Maximum number of devices specified for one report screen
Up to 260 devices can be specified for one report screen.
The object devices, collection trigger device, output trigger device, and other devices set for a report screen are included.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

System application (extended function) Description

[Report] This system application will be incorporated into the package data automatically if a report 
screen is created.

[Printer(PictBridge)]
[Printer(Serial)]
[Printer(ESC/P-R)]
[Printer(PCL5)]

One of the system applications will be incorporated into the package data automatically 
according to the setting of [Printer Type] in the [Printer] dialog.

[File Print]

This system application is required to perform the following operations.
• Printing a report file with the file print function
• Outputting a report to a file
• Outputting operation log lines
When the following settings are configured, [File Print] of the system application (extended 
function) will be incorporated into the package data automatically.
• [File Print] is selected for [Switch Action] on the [SP Function] tab in the [Special Function 

Switch] dialog.
• [Output operation logs to a report screen] is selected on the [Report Setting] tab in [Operation 

Log] in the [Environmental Setting] window.
If you do not configure the above settings but only execute a report file output or perform other 
operations, you need to install [File Print] of the system application (extended function) 
manually.
For the installation, refer to the following.

➟4.8.4 [Application Selection] dialog

[Output Destination] in the [Action] tab [Output Timing] in the [Action] tab Data storage or file server

[Printer]

[At the time of data collection] ×

[When trigger condition is satisfied] ○ *1

[When one page's worth of data is collected] ×

[File]
[At the time of data collection] ○

[When trigger condition is satisfied] ○ *1
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(3) Figures and objects on a report screen
The following shows the figures and objects that can be placed on a report screen.

(4) KANJI region for a report screen
The KANJI region of the figure, object, or header at the top leftmost corner of a report screen applies to the text on the 
screen.
If a report screen does not have any figure or object with a KANJI region setting, the KANJI region will be set to [Japan].
If an alarm line is output ahead of a repeat line, the KANJI region of the basic alarm comment in the alarm line will apply 
to the text on the screen.
For printer output, a KANJI region applies to a page.
For file output, a KANJI region applies to a report file.

(5) Page layout
The margins of a page and the maximum numbers of lines and columns per page are common to all report screens.
For serial printers, the print area varies by printer model.
Set the page layout according to the size of the print area.

*1 As GT SoftGOT2000 outputs a report to a CSV file in a virtual drive instead of to a printer, the paper size setting is 
nonexistent accordingly.

*2 The setting range for PictBridge-compatible printers applies to GT SoftGOT2000.

Item Description

Figure Line, text

Object Numerical print, text print, bit comment print, word comment print

Item PictBridge-compatible printer Serial printer Ethernet printer

Paper size *1 A4 (portrait) Depending on the printer specifications A4 (portrait) or letter

Top margin *2 0 lines to 31 lines 0 lines to 31 lines 0 lines to 31 lines

Number of lines per page *2 1 line to 70 lines 1 line to 127 lines 1 line to 70 lines

Left margin *2 0 columns to 123 columns 0 columns to 254 columns 0 columns to 123 columns

Number of columns per page *2 1 column to 124 columns 1 column to 255 columns 1 column to 124 columns

Top margin

Left margin

Number of 
lines per page

Number of 
columns per page

Print area

Contents of a report
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■5 Report samples and the items to be output to a report
The following shows report samples and the items to be output to a report.

Item Description

Date and time, page number

These items are available for printer output.
The printing date and time and page numbers are printed.
They are printed in one line above the header of each page.
Configure the settings in the [Screen Property] dialog of a report screen.

➟2.7.3 Property of report screens
• Date and time

Select [Output date/time] in the [Format] tab.
Specify 4 or more for [Page Columns] in the [Report Setting] dialog.

• Page number
Select [Output page No.] in the [Format] tab.
Specify 17 or more for [Page Columns] in the [Report Setting] dialog.

Page header

This item is available for file output.
When a report file is printed using the file print function, the printing date and time and the operator name are 
printed.
They are printed in one line per page.
They appear at the top line of the area that is specified with [Page Lines] in the [Report Setting] dialog.
Set the contents of the page header in the [Edit Page Header/Page Footer] dialog.

➟10.11.6 [Edit Page Header/Page Footer] dialog
Enable the output of the page header in the [Screen Property] dialog of each report screen.

➟2.7.3 Property of report screens
The following shows an example of the page header that has the date and time on the left and the operator name 
on the right.

ITEM X Y

LINE A
100 100

150 300

LINE B
100 100

300 50

2018/7/1 17:38:04 1

ITEM X Y

LINE A
100 100

150 300

LINE B
100 100

300 50

Date and time, 
page number

Header

Footer

Body
･Repeat line
･Alarm line
･Operation log line

Sample of a printed report Sample of a report file to be printed

Footer

Header

Body
･Repeat line
･Alarm line
･Operation log line

Page header

Page footer

18/7/1 17:38:04 user118/7/1 17:38:04 user1

Date and time Operator name

Page header

Page 1 Page 2
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Header

The header is output above the body.
The header lines specified in a report screen are output.
For the setting method, refer to the following.

➟10.11.3 ■3 Creating a report screen
The following shows an example of the header in a report.

Body (repeat line)

A repeat line specified in a report screen is output.
The following shows the output timing.
• When the output trigger condition is satisfied

The line is output the specified number of times.
Number of outputs: Number of repeats + 1

• When data are collected
The line is output simultaneously with data collection.

If the number of lines of all types exceeds the set value of [Page Lines] in the [Report Setting] dialog, a page break 
will be inserted between iterations of repeat lines.
For specifying a repeat line, refer to the following.

➟10.11.3 ■3 Creating a report screen
The following shows an example of the report where a repeat line having a numerical print object is output three 
times.

Body (alarm line)

The set items are output at occurrence, check, or reset of the alarms to be collected by the user alarm observation 
function.
For the items to be output, refer to the following.

➟9.1.2 ■7 (2) [Device] tab
The following shows the output timing.
• When the output trigger condition is satisfied

The line is output the specified number of times.
Number of outputs: Number of repeats + 1

• When data are collected
The line is output at occurrence, check, or reset of an alarm.
Specify the alarms to be output with [Print Target] in the [Alarm Print Detail Setting] dialog.

Each alarm event is output in one line.
If the number of digits output in an alarm line exceeds the set value of [Page Columns] in the [Report Setting] 
dialog, only the digits within the limit will be output.
For the settings to output an alarm line, refer to the following.

➟10.11.3 ■4 Settings to output alarm lines
The following shows an example of alarm lines in a report.

For the user alarm observation, refer to the following.

➟9.1.2 Collecting alarms by monitoring devices

Item Description

ITEM X YITEM X Y Header

Page 1 Page 2

TEST 100

TEST

TEST

50

200

Numerical print object

Body (repeat line)

Body (repeat line)

Body (repeat line)

First repetition

Second repetition

18/07/01 20:35 alarm2 Ocr

18/07/01 20:13 alarm1 Ocr

18/07/01 22:05 alarm1 Rstr

Body (alarm line)

Body (alarm line)

Body (alarm line)

Occurrence of 
an alarm

Occurrence of 
an alarm

Reset of 
an alarm
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Body (operation log line)

The set items are output when the operation log function records an operation event.
For the items to be output, refer to the following.

➟5.2.11 ■5 (4) [Report Setting] tab
The following shows the output timing.
• When the output trigger condition is satisfied

The line is output the specified number of times.
Number of outputs: Number of repeats + 1

• When data are collected
The line is output when an operation event is recorded.

Each operation event is output in the specified number of lines.
For the settings to output an operation log line, refer to the following.

➟10.11.3 ■5 Settings to output operation log lines
The following shows an example of operation log lines in a report.

For the operation log function, refer to the following.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])

Footer

The footer is output below the body.
The footer lines specified in a report screen are output.
For the setting method, refer to the following.

➟10.11.3 ■3 Creating a report screen
The following shows an example of the footer in a report.

Page footer

This item is available for file output.
When a report file is printed using the file print function, the printing date and time and the operator name are 
printed.
They are printed in one line per page.
They appear at the bottom line of the area that is specified with [Page Lines] in the [Report Setting] dialog.
Set the contents of the page footer in the [Edit Page Header/Page Footer] dialog.

➟10.11.6 [Edit Page Header/Page Footer] dialog
Enable the output of the page footer in the [Screen Property] dialog of each report screen.

➟2.7.3 Property of report screens
The following shows an example of the page footer that has a page number and the total number of pages in the 
center.

Item Description

18/07/01 14:54 Speed user1 100 50

18/07/01 14:53 OFF user1 1 0

18/07/01 14:55 ON user1 0 1

Body 
(operation log line)

Body 
(operation log line)

Body
(operation log line)

Operation of a 
touch switch

Operation of a 
numerical input object

Operation of a 
touch switch

REPORT REPORT

Page 1 Page 2

Footer

2/21/2

Page 1 Page 2

Page footer

Page number/Total number of pages
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■6 Output destination of a report
The following shows the output destinations selectable for a report.

Output destination Description Supported 
models

Printer

A report is output to a printer.

GT SoftGOT2000 outputs a report to a CSV file in a virtual drive instead of to a printer.
Output the CSV file to a printer from the personal computer.
For the specifications of the report function on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

File

A report is output to a report file.
To output the report file to a printer, use the file print function.
For the file print function, refer to the following.

➟GOT2000 Series User's Manual (Utility)

For the specifications related to a report file, refer to the following.

➟10.11.2 ■7 Specifications related to a report file

Report

Output to a printer

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

Report

Output to a printer

Report function

Output to a report file

Report file

File print function

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.11 Outputting the Collected Data as a Report (Report Function)

10 - 177



■7 Specifications related to a report file
The following shows the specifications related to a report file.

(1) Specifying a report file
The following shows how to specify a report file to which a report will be output.
Specify a destination report file per report screen.

(2) Switching report files
You can switch a destination report file to a new one at your preferred timing.
Once the destination report file is switched, the file will be write-protected.
The destination report file is switched under the following conditions.

• The data of a report screen is output when [Switch files after an output] is enabled for the screen.
• The screen data is output while bit 0 of the notification device is turned off by turning on bit 0 of the control device.
• In the case where a destination report file is specified with devices, the screen data is output to another new report 

file.
Note that restarting the GOT write-protects all report files.

When you specify a destination report file directly, a sequential number is appended to the report file name.
Example) REPORT01_0000.G2R
The sequential number starts from 0000. When REPORT01_0000.G2R is switched to a new report file, the new file is 
named REPORT01_0001.G2R.
After sequential number 9999 is used, sequential number 0000 will be used.

Item Description

Outputting screen data to a new report file

The data of a report screen is output to a new report file.
Example) Outputting the data of report screens 1 to 3 to new report files respectively

Adding screen data to the report file created 
for another report screen

The data of a report screen is added to the report file created for another report screen.
You can output the data of multiple report screens to one report file.
Example) Adding the data of report screens 2 and 3 to the report file created for report screen 1

REPORT01 REPORT02 REPORT03

Report screen 1 Report screen 2 Report screen 3

REPORT01

Report screen 1 Report screen 2 Report screen 3
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(3) Report file's sequential number and management file
The sequential number of a report file is managed with a management file (*.G2G).
When a report file is created in a folder, its management file with the same name (excluding the sequential number) is 
also created in the folder.
Example) For REPORT01_****.G2R, its management file is REPORT01.G2G.
To change the sequential number of a report file, perform one of the following operations.

• Change the setting of [File Name] on the [File Save] tab in the [Screen Property] dialog for a report screen.
• Delete the report file and its management file.

■8 Report output timing
The following shows the timing for outputting data as a report.

• When the output trigger condition is satisfied
• When data are collected
• When one page's worth of data is collected

Set the output timing per report screen.

(1) When the output trigger condition is satisfied

The collected data is stored into a temporary file, and is collectively output as a report when the output trigger condition 
is satisfied.
The data in the temporary file is deleted when the delete trigger condition is satisfied.
Set the following items per report screen: the data collection trigger, the data output trigger, the maximum number of 
collections of data to be stored into a temporary file, and the number of collections of data to be output when the output 
trigger condition is satisfied.

➟2.7.3 Property of report screens

Example) Outputting three collections of data when the output trigger condition is satisfied
The following shows how the data is output when the following settings are configured in the [Screen Property] dialog of 
a report screen.

• [Limit of Collection] in the [Action] tab: 3
• [Number of repeats] in the [Format] tab: 2

When the collection trigger condition is satisfied, data is stored into a temporary file.
Up to three collections of data are stored into the temporary file.
When the output trigger condition is satisfied, the stored data is output. (Number of collections of output data: Number of 
repeats + 1).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1

10
30
50

2

70
40
60

10 30 50 70 40 60 80

10, 30, 50 70, 40, 60

Device value

Collection trigger

Output trigger

Delete trigger

Temporary file

The data in the temporary file is deleted. The data in the temporary file is deleted.

The output trigger condition 
is satisfied for the first time.

The output trigger condition 
is satisfied for the second time.

First repetition
Second repetition

First repetition
Second repetition
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(2) When data are collected

The collected data is output simultaneously with data collection.
This is available only when a serial printer is used.
The data collection timing depends on the item to be output.

Example) Repeat lines in a report

Example) Alarm lines in a report
Alarm 1: Output at occurrence or check
Alarm 2: Output at reset

Item to be output Data collection timing

Repeat line When the collection trigger condition is satisfied

Alarm line At occurrence, check, or reset of the alarms to be collected by the user alarm observation function

Operation log line When an operation event is recorded

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

10 30 50 70 40 60 80 100

1

10

1

10
30

1

10
30
50

Device value

Collection trigger

The collection trigger condition 
is satisfied for the first time.

The collection trigger condition 
is satisfied for the second time.

The collection trigger condition 
is satisfied for the third time.

Alarm 1 occurred. Alarm 1 is checked.

1

2018/07/01 20:13 alarm1 Ocr

Alarm 2 is reset.

Alarm 1

Alarm 2

Occurrence Reset

ResetOccurrence

Check

1

2018/07/01 20:13 alarm1 Ocr
2018/07/01 20:35 alarm1 Chk

1

2018/07/01 20:13 alarm1 Ocr
2018/07/01 20:35 alarm1 Chk
2018/07/01 22:05 alarm2 Rstr
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(3) When the output trigger condition is satisfied

Not available to GT2105-Q.
Available when [Printer Type] is set to [PCL5].
Data is output when one page's worth of data is collected.
Set the data collection and output triggers per report screen.

➟10.11.5 [Report Setting] dialog
When the data output trigger condition is satisfied before one page's worth of data is collected, the data is output.

Example) Setting repeat lines to be output when one page's worth of repeat lines are collected

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device value

Collection trigger

Output trigger

10 30 50 70 40 60 80 100

1

10
30
50

2

70
40
60

80

One page's worth of data is collected. The output trigger condition is satisfied.
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10.11.3 How to use the report function

■1 System configuration
The following shows the system configuration when a printer is used.
For connecting a printer to the GOT, refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

GT SoftGOT2000 outputs a report to a CSV file in a virtual drive instead of to a printer.
For the specifications of the report function on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(1) When connecting with a PictBridge-compatible printer

*1 The unit for the communication between the GOT and the PictBridge-compatible printer.
Some PictBridge-compatible printers may not be able to print data properly.
For the precautions of the printer connection, refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)

*2 GT25-W, GT2505-V, and GT25HS-V are excluded.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Printer Connection cable GOT
PLC

Number of 
connectable 

printersModel Model Option GOT 
model

For the connectable printers and system 
devices, refer to the following Technical 
News.
➟List of Valid Devices Applicable for 

GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-0160)

GT09-C30USB-5P (3m) 
(included in the printer unit) GT15-PRN*1 GT27,

GT25*2

For the system 
configuration between 
the GOT and the PLC, 
refer to each connection 
manual.

One printer for 
one GOT

PLCGOT
PictBridge-
compatible 

printer
Connection cable

Available cables differ 
depending on the connection type.
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(2) When connecting with a serial printer

*1 Available RS-232 cables differ according to the printer used.
Prepare a RS-232 cable that is suitable for the specifications of the printer to be used.

*2 GT25HS-V is excluded.
*3 GT25-W, GT2505-V, and GT25HS-V are excluded.

Printer Connection cable GOT
PLC

Number of 
connectable 

printersModel Model Option GOT 
model

For the connectable printers and system 
devices, refer to the following Technical 
News.

➟List of Valid Devices Applicable for 
GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-0160)

RS-232 cable *1
-(Built into GOT)

GT27
GT25 *2

GT23
GT21
GS25
GS21

For the system configuration 
between the GOT and the 
PLC, refer to each connection 
manual.

One printer for 
one GOT

GT15-RS2-9P
GT27

GT25 *3

GOT PLC

Available cables differ 
depending on the connection type.

Serial 
printer

Connection cable
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(3) When connecting with an Ethernet printer

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 When a hub is used, use a straight cable.
To connect the GOT and the printer directly with an Ethernet cable, use a straight or cross cable.
For the cables usable for your printer, check the printer specifications.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 for a cascade connection (500m)
• 100BASE-TX: Up to 2 for a cascade connection (205m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 GT25-W, GT2505-V, and GT25HS-V are excluded.
*7 GT2505-V and GT25HS-V are excluded.
*8 For GT2505HS-V, one built-in interface is usable.

An Ethernet printer is connectable only when the GOT is connected to a controller by Ethernet.
*9 GT2105-Q is excluded.

Printer Connection cable *1*2,
wireless LAN access point

Maximum 
segment 
length *3

GOT

PLC

Number of 
connectable 

personal 
computersOption GOT 

model

Select by each user

➟List of Valid Devices 
Applicable for GOT2000 
Series and GOT SIMPLE 
Series (for Overseas) (GOT-
A-0160)

• 100BASE-TX
Shielded twisted pair cable (STP) 
or unshielded twisted pair cable 
(UTP) of category 5 or higher

• 10BASE-T
Shielded twisted pair cable (STP) 
or unshielded twisted pair cable 
(UTP) of category 3 or higher

100m

- (Built into GOT)

GT27

GT25 *8

GT23

GT21 *9

GS25
GS21

For the system 
configuration 
between the GOT 
and the PLC, refer 
to each connection 
manual.

One personal 
computer for 
one GOT

GT25-J71E71-100
GT27

GT25 *6

- - GT25-WLAN
GT27 *4

GT25 *4*7

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN 
access points and system 
devices, refer to the following 
Technical News.
➟List of Valid Devices 

Applicable for GOT2000 Series 
and GOT SIMPLE Series (for 
Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *5

GT25 *5*7

GS25 *5

The system configuration between GOT and PLC 
depends on the connection type.

Ethernet printer GOT PLC

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
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■2 Setting procedure
(1) For GT27, GT25, GT23, GT21, GS25, and GS21

Step 1 Connect the GOT and a printer.

➟GOT2000 Series Connection Manual (Microcomputer, MODBUS/Fieldbus Products, Peripherals) 
for GT Works3 Version1

Step 2 Select [Common] → [Peripheral Setting] → [Printer] from the menu to display the [Printer] dialog.
Step 3 In the [Printer] dialog, set a printer to be connected to the GOT.

➟10.11.8 [Printer] dialog
Step 4 Create a report screen.

➟■3 Creating a report screen
To output alarm lines, configure the output settings of the user alarm observation function.

➟■4 Settings to output alarm lines
To output operation log lines, configure the output settings of the operation log function.

➟■5 Settings to output operation log lines
Step 5 In the [Report Setting] dialog, set the cycle of monitoring trigger devices and set the page layout of a report.

➟■6 Settings common to report screens

(2) For GT SoftGOT2000
Step 1 Create a report screen.

➟■3 Creating a report screen
To output alarm lines, configure the output settings of the user alarm observation function.

➟■4 Settings to output alarm lines
To output operation log lines, configure the output settings of the operation log function.

➟■5 Settings to output operation log lines
Step 2 In the [Report Setting] dialog, set the cycle of monitoring trigger devices and set the page layout of a report.

➟■6 Settings common to report screens
Step 3 On GT SoftGOT2000, select the [Project] menu and configure the print settings.

➟GT SoftGOT2000 Version1 Operating Manual

■3 Creating a report screen
For the procedure for creating a report screen, refer to the following.

➟2.5.1 ■3 Creating a report screen
The following shows the space between figures or objects when they are placed or moved.

The grid color can be changed in the [View] tab of the [Options] tab.
➟11.10.5 Customizing the display

Item Space between figures or objects

Figure
Line Place or move this item in units of 16 dots vertically or horizontally.

Text Place or move this item in units of 16 dots vertically or in units of 8 dots horizontally.
Use the grid as a reference.
The vertical and horizontal spacing between dots in the grid on a report screen are fixed to 
16 dots and 8 dots respectively.

Object
16 dots

8 dots

Grid
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(1) Drawing lines and squares
(a) How to draw

Place each line and square not to overlap each other.
Step 1 Select [Figure] → [Line] from the menu.
Step 2 Drag the pointer from the start point to the end point and release the left button on the mouse to draw a line 

or a square.
• Drawing a line Drag the pointer from the start point horizontally or vertically to draw a line.

• Drawing a square Drag the pointer from the start point diagonally to draw a square.

(b) Precautions
The property of the line is fixed as follows.

• Line style: Solid line
• Line width: 1 dot
• Line color: Black

(2) Placing text
(a) How to place text

Step 1 Select [Figure] → [Text] from the menu.
Step 2 Click the position where you place the text. The [Text] dialog appears.

Step 3 Input character strings you want to display and then click the [OK] button.
Set the KANJI region as required.

Step 4 The input text is displayed on the screen.

(b) Precautions
• Line feeds cannot be inserted to the text on the report screen.
• The character property (character effect, character color, and others) cannot be changed.
• Two-byte characters are placed by 16 dots × 16 dots. One-byte characters are places by 16 dots × 8 dots.

• For PictBridge-compatible printers or Ethernet printers, up to 62 two-byte or 124 one-byte characters can be output.
• For serial printers, up to 127 two-byte or 255 one-byte characters can be output.

(1) (2)

(1)

(2)

(Two-byte 
character)

(One-byte 
character)

8 dots16 dots

16 dots
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(3) Placing an object
For the object placement and setting on a report screen, refer to the following.

➟8.32 Placing a Print Object on a Report Screen

(4) Setting the header, footer, and repeat lines
Set the items (header, footer, and repeat lines) to be output to a report on a report screen.
If repeat lines are set to be output, specify them.
Make sure that the number of lines to be output to a report does not exceed the set value of [Page Lines] in the [Report 
Setting] dialog. The header lines, footer lines, repeat lines, page header lines, and alarm lines are included.
For the number of lines to be output to a report, refer to the following.

➟10.11.2 ■5 Report samples and the items to be output to a report
The following shows the setting procedure.

Step 1 Open a report screen, and perform one of the following operations.
• Select [Edit] → [Object of Selection] → [Report Line] from the menu.
• Click the [Object of Selection:Report Line] button on the [Report] toolbar.

➟2.2.2 ■14 [Report]
Step 2 On the report screen, select a line to be a header, footer, or repeat line.

To select multiple lines, drag the target lines.

Step 3 Click an appropriate button on the [Report] toolbar according to the target to be set.

Step 4 The selected line is set as a header, footer, or repeat line, and is enclosed in a colored frame.
• Header: Cyan frame
• Footer: Red frame
• Repeat row: Yellow frame

Alternative setting methods
The header, footer, repeat lines are also settable in the following dialogs.

• [Format] tab in the [Screen Property] dialog of a report screen
➟2.7.3 ■3 [Format] tab
• [Header/Footer/Repeat] dialog
➟10.11.7 [Header/Footer/Repeat] dialog

Sets the selected line as a repeat line.

Sets the selected line as a header line.
Sets the selected line as a footer line.
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■4 Settings to output alarm lines
To output the alarm events that are collected by the user alarm observation, configure the settings of a report screen and 
the user alarm observation as shown below.

(1) Setting of the report screen
Step 1 Perform one of the following operations to set a report screen so that alarm lines will be output to a report.

• Click the screen editor.
• Select a screen in the [Screen] window.

Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog for the report 
screen.

Step 3 In the [Format] tab, select [Alarm] for [Output Target].

➟2.7.3 ■3 [Format] tab
Step 4 Click the [OK] button to apply the setting.

(2) Setting of the user alarm observation
For the specifications and settings of the user alarm observation, refer to the following.

➟9.1.2 Collecting alarms by monitoring devices
Step 1 Select [Common] → [Alarm] → [User Alarm Observation] from the menu to display the [User Alarm 

Observation List] dialog.

➟9.1.2 ■6 [User Alarm Observation List] dialog
Step 2 Perform one of the following operations to display the [User Alarm Observation] dialog.

• Click the [New] button.
• Select a user alarm observation setting and click the [Edit] button.

➟9.1.2 ■7 (2) [Device] tab
Step 3 Click the [Additional Setting] button in the [Device] tab to display the [Additional Setting] dialog.
Step 4 Select [Alarm Print] and click the [Alarm Print Detail Setting] button to display the [Alarm Print Detail Setting] 

dialog.
Step 5 Set necessary items and click the [OK] button.
Step 6 In the [Additional Setting] dialog, click the [OK] button.
Step 7 In the [User Alarm Observation] dialog, click the [OK] button to apply the setting.

Outputting a reset alarm event
When selecting [Print the information of restored alarms] for [Print Target] in the [Alarm Print Detail Setting] 
dialog, do not configure the following setting.

• In the [User Alarm Observation] dialog, select [Only current alarm] for [Collection Mode] in the [Basic] 
tab.

Doing so disables the output of reset alarm events.

■5 Settings to output operation log lines
To output the operation events that are recorded by the operation log function, configure the settings of a report screen 
and the operation log function as shown below.

(1) Setting of the report screen
Step 1 Perform one of the following operations to set a report screen so that operation log lines will be output to a 

report.
• Click the screen editor.
• Select a screen in the [Screen] window.

Step 2 Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog for the report 
screen.

Step 3 In the [Format] tab, select [Operation Log] for [Output Target].

➟2.7.3 ■3 [Format] tab
Step 4 Click the [OK] button to apply the setting.
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(2) Settings of the operation log function
For the specifications and settings of the operation log function, refer to the following.

➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])
Step 1 Select [Common] → [GOT Environmental Setting] → [Operation Log] from the menu to display [Operation 

Log] in the [Environmental Setting] window.

➟5.2.11 ■5 [Operation Log...]
Step 2 Select [Collect operation logs].
Step 3 In the [Report Setting] tab, select [Output operation logs to a report screen].

➟5.2.11 ■5 (4) [Report Setting] tab
Step 4 Configure the settings and click the [OK] button to apply the settings.

■6 Settings common to report screens
Set the numbers of lines and columns per page and the cycle of monitoring the relevant trigger devices.
Create a report screen, and then configure the settings.

➟2.5.1 ■3 Creating a report screen
Step 1 Select [Screen] → [Report Setting] from the menu to display the [Report Setting] dialog.
Step 2 Configure the settings, and click the [OK] button.

➟10.11.5 [Report Setting] dialog
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.11 Outputting the Collected Data as a Report (Report Function)

10 - 189



■7 Aborting a printer output
If the output destination is set to a printer, you can abort a printer output.
If a printer output is aborted, the paper will be ejected from the printer during printing.
The following shows how to abort an output.

When [Output Timing] is set to [When trigger condition is satisfied] and [Delete Trigger] is set to [Output] for a report 
screen, the data of a temporary file will not be deleted after a printer output is aborted.

■8 Process notification device
The process notification device is used to notify that report data collection or output is in progress.
Collection in-progress or output in-progress is notified by b0 or b1 of the process notification device.
• b0: This bit is on while report data is being collected (Collection in-progress signal).
• b1: This bit is on while report data is being output (Output in-progress signal).

To ensure that data collection or output is performed, turn on the collection trigger or output trigger when the notification 
signal is off.

Set the process notification device per report screen.
To use the device, configure the settings in the screen property per report screen.
For details, refer to the following.

➟2.7.3 ■2 [Action] tab
When the GOT starts up or returns from offline, all the process notification devices set for the report screens are initialized 
and both the Collection in-progress signal and Output in-progress signal turn off.

Note that alarm output and operation log output are not the operations relevant to the collection trigger.
Therefore, the Collection in-progress signal is not applicable to those events.

Means of aborting an output Description

Abort trigger

An abort trigger is set per report screen.
Set the abort trigger in the [Screen Property] dialog of a report screen.

➟2.7.3 ■2 [Action] tab
If the abort trigger condition is satisfied, the output of one collection of data will be aborted.
When [Output Timing] is set to [At the time of data collection] for a report screen, if multiple alarms occur 
or are reset simultaneously, multiple printer outputs will occur successively. To abort the successive 
outputs, use system signal 1-2.b15.
If the abort trigger condition is satisfied, the output of one alarm event will be aborted only. The outputs 
of the subsequent alarm events cannot be aborted.

Output abort trigger

The output abort trigger is common to all report screens.
Set the output abort trigger in the [Report Setting] dialog.

➟10.11.5 [Report Setting] dialog
If the abort trigger condition is satisfied, the output of one collection of data will be aborted.
When [Output Timing] is set to [At the time of data collection] for a report screen, if multiple alarms occur 
or are reset simultaneously, multiple printer outputs will occur successively. To abort the successive 
outputs, use system signal 1-2.b15.
If the output abort trigger condition is satisfied, the output of one alarm event will be aborted only. The 
outputs of the subsequent alarm events cannot be aborted.

System signal 1-2.b15

This signal is common to all report screens.
Set the signal in [System Information] in the [Environmental Setting] window.

➟5.2.5 ■4 [System Information]
While this signal is turned on, a printer output is aborted.

Collection trigger OFF

ON ON

Data collection process

Collection in-progress signal OFF

ON ON
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(1) Collection in-progress signal
Notifies that report data is being collected.
This can be used when [Rise] or [Fall] is selected for [Collection Trigger].
Notification is performed with b0 of the process notification device.

When the collection trigger condition is satisfied, the Collection in-progress signal (b0 of the process notification device) 
turns on.
The Collection in-progress signal turns off when all the following conditions are satisfied.
• Data collection process is completed.
• The collection trigger condition is unsatisfied.

Example 1) Operation when [Rise] is selected for [Collection Trigger]
After checking that the Collection in-progress signal turns on, if you turn off the collection trigger device, the Collection 
in-progress signal turns off at completion of data collection.

Step 1 Turn on the collection trigger device.
The Collection in-progress signal turns on.

Step 2 Check that the Collection in-progress signal turns on, and turn off the collection trigger device.
When the collection trigger device is turned off, the Collection in-progress signal turns off at completion of 
data collection.

OFF

ON ON

OFF

ON ON

Turn on the collection trigger device.1.
2.

If the collection trigger is not turned off, the 
process notification signal does not turn off at 
completion of data collection.

Check that the Collection in-progress signal is on, and turn off the device.

Data collection process

Collection in-progress signal

Collection trigger
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Example 2) Operation when multiple collection trigger devices are simultaneously turned on
The following shows the operation when multiple collection trigger devices are simultaneously turned on.
Detection of collection trigger and turning on of Collection in-progress signal occur sequentially per screen.

(2) Output in-progress signal
Notifies that report data is being output.
Notification is performed with b1 of the process notification device.

When the output trigger condition is satisfied, the Output in-progress signal (b1 of the process notification device) turns 
on.
The Output in-progress signal turns off when all the following conditions are satisfied.
• Data output process (including abnormal end and interruption) is completed.
• The output trigger condition is unsatisfied.

When [Serial] or [PCL5] is set for [Printer Type] in the [Printer] dialog, the GOT determines data output completion when 
data output from the GOT to a printer is completed, not when data output from the printer is completed.
The relationship between the output trigger, Output in-progress signal, and output process is the same as that described 
for the Collection in-progress process.
For details, refer to the following.

➟10.11.3 ■8 (1) Collection in-progress signal

Check that the Collection in-progress signal for screen 1 is on, 
     and turn off the device.

Report screen 1
Collection trigger

OFF

ON

Report screen 1
Data collection process

Report screen 1
Collection in-progress signal

Report screen 2
Collection trigger

Report screen 2
Data collection process

Report screen 2
Collection in-progress signal

OFF

ON

Turn on the collection trigger device.

When the collection trigger device is turned off, the 
process notification signal turns off at completion of 
screen 1 data collection.

When the collection trigger device is turned off, the 
process notification signal turns off at completion of 
screen 2 data collection.

The operation is sequentially performed 
when the Collection in-progress signal for screen 2 is on.

OFF

ON

OFF

ON

Check that the Collection in-progress signal for screen 2 is on, 
     and turn off the device.

Turn on the collection trigger device at the same time as turning on the device for screen 1.
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■9 Examples of report screen settings
The following shows examples of report screen settings and reports.

(1) Outputting the page numbers, header, repeat lines, and footer (to a printer)
The following shows an example of report screen settings.
The setting items unmentioned below are assumed to be set to their defaults.

The following shows an example of a report.

Setting location Settings

[Printer] dialog
• [Use Printer]: Selected
• [Connection Type]: [Ethernet]

[Screen Property] dialog (report 
screen)

[Action] tab

• [Output Destination]: [Printer]
• [Output Timing]: [When trigger condition is satisfied]
• [Collection Trigger]: [Rise], GB1000
• [Output Trigger]: [Rise], GB1001
• [Limit of Collection]: 3

[Format] tab

• [Set header]: Selected
• [Start] (header): 1
• [End] (header): 2
• [Repeat] of [Output Target]: Selected
• [Start] (repeat line): 6
• [End] (repeat line): 7
• [Number of repeats]: 2
• [Set footer]: Selected
• [Start] (footer): 11
• [End] (footer): 12
• [Output page No.]: Selected

Screen editor

[Report Setting] dialog • All setting items are set to their defaults.

Word comment print object Numerical print object

Repeat line

Header

Footer

LINE X Y

LINE_A 100 50

LINE_B 200 150

LINE_C 300 250

LINE_A 1000 500

LINE_B 2000

LINE_B 800 500

LINE_C 1500 2500

350

1

REPORT

Header

Footer

Page number

Repeat line
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(2) Outputting the page header, header, alarm lines, footer, and page footer (to a file)
The following shows an example of report screen settings.
The setting items unmentioned below are assumed to be set to their defaults.

The following shows an example of a report.
The page header and page footer are not visible until the report file is printed using the file print function.

Setting location Settings

[Printer] dialog
• [Use Printer]: Selected
• [Connection Type]: [Ethernet]

[Screen Property] dialog (report 
screen)

[Action] tab

• [Output Destination]: [File]
• [Output Timing]: [When trigger condition is satisfied]
• [Output Trigger]: [Rise], GB1001
• [Limit of Collection]: 10000

[Format] tab

• [Output page header]: Selected
• [Set header]: Selected
• [Start] (header): 1
• [End] (header): 2
• [Alarm] of [Output Target]: Selected
• [Set footer]: Selected
• [Start] (footer): 5
• [End] (footer): 6
• [Output page footer]: Selected

[File Save] tab • [Specification]: [Direct]

Screen editor

[Report Setting] dialog [Edit Page Header/Page 
Footer] dialog

• [Left section] of [Page Header]: [Date + Time]
• [Right section] of [Page Header]: [Operator Name]
• [Center section] of [Page Footer]: [Page/Pages]

[User Alarm Observation] dialog

[Device] tab
• [Alarm Points]: 3
• [Device]: X1000

[Additional Setting] dialog • [Alarm Print]: Selected

[Alarm Print Detail Setting] 
dialog • All setting items are set to their defaults.

Header

Footer

18/6/29 21:11:05  alarm1 Rstr

//footer

1/1

18/6/29 21:13:47  alarm1 Rstr

//header

18/5/24 20:00:19  alarm1 Ocr

18/5/24 20:05:50  alarm1 Rstr

18/5/25 09:13:07  alarm2 Ocr

18/5/25 09:13:07  alarm3 Ocr

18/5/25 09:25:13  alarm2 Rstr

user118/7/1 17:38:04

Header

Footer

Alarm line

Page header

Page footer
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10.11.4 Precautions

■1 Precautions on the report screen settings
(1) Collection cycle and number of devices on the report screen for the monitor display

Note that it takes longer time than usual for the GOT to display the monitor screen when the number of set devices in the 
report screen is large.
When it takes longer, extend the data collection cycle or reduce the number of devices.

(2) Text to be printed when a serial printer is used
When [Serial] is selected for [Printer Type], text is converted into shift JIS code or ASCII code for printing.
If any language other than Japanese and English is used, the text will be printed improperly.
Use Japanese or English for the text to be printed.

(3) Page layout settings
Make sure that the number of lines to be output to a report does not exceed the set value of [Page Lines] in the [Report 
Setting] dialog. The header lines and repeat lines are included.
For the number of lines to be output to a report, refer to the following.

➟10.11.2 ■5 Report samples and the items to be output to a report
If report screen data is added to the report file created for another report screen, the number of lines will include the page 
header and footer lines of the screen for which the file is created.
The following shows an example where a report cannot be output.

Example 1) When outputting the date and time, page numbers, header, alarm lines, and footer to a report
When the settings are configured as shown below, the total number of lines to be output is 7.

• Date and time, page number: 1 line
• Header: 3 lines
• Alarm line: 1 line
• Footer: 2 lines

If [Page Lines] is set to 6 or less in the [Report Setting] dialog, no report will be output.

Example 2) When outputting the date and time, page numbers, header, operation log lines, and footer to a report
When the settings are configured as shown below, the total number of lines to be output is 9.

• Date and time, page number: 1 line
• Header: 3 lines
• Operation log line: 3 lines per event (when line feeds are inserted)
• Footer: 2 lines

If [Page Lines] is set to 8 or less in the [Report Setting] dialog, no operation log line will be output.

(4) Precautions for a report screen having an alarm line
There is a limit on the number of report screens where the following settings are configured in the [Screen Property] 
dialog.

• [Output Timing] is set to [At the time of data collection] in the [Action] tab.
• [Alarm] is selected in the [Format] tab.

The maximum number of such report screens differs depending on the report output destination setting.
• When [Output Destination] is set to [Printer]: 1 screen per project
• When [Output Destination] is set to [File]: 1 screen per report file

(5) Precautions for a report screen having an operation log line
There is a limit on the number of report screens where the following settings are configured in the [Screen Property] 
dialog.

• [Output Timing] is set to [At the time of data collection] in the [Action] tab.
• [Operation Log] is selected in the [Format] tab.

The maximum number of such report screens differs depending on the report output destination setting.
• When [Output Destination] is set to [Printer]: 1 screen per project
• When [Output Destination] is set to [File]: 1 screen per report file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(6) If an outputted report is blank
Check the following settings.

• Top margin
The printable range may have exceeded.
Adjust the top margin by adding about five lines to the current setting value or in other ways.

• Setting value of [Number of repeats] for a report
To print all the collected data, set "999" to [Number of repeats] in the [Format] tab in the [Screen Property] dialog for 
a report screen.
If "1" is set, only two pieces of collected data from the top are printed. The 3rd and subsequent pieces of data are 
not printed.
Also, turn on GS524.b2.
Turning on GS524.b2 can prevent empty lines of uncollected data from being output when the number of data 
collection is less than the number of repeats. (Only the collected data within the number of repeats can be printed.)

■2 Precautions for placing a figure or object on a report screen
(1) Placing a figure or object

Do not overlap figures and objects on a report screen.
Doing so cannot output the screen data properly.
If an object or figure is tangent to a line or any line of a rectangle, the screen data may not be output properly.
In such a case, make a space between a line and an object or figure.

(2) Precautions for the numerical print
In the [Numerical Print] dialog, when the print format is set to binary, 0 is always prepended to the value even though [Fill 
with 0] is deselected.

➟8.32.4 ■1 [Device/Style] tab

(3) Precautions for the text print
If the set text contains a line feed code, only the first line of the text will be output.

(4) Character code when a string-type label or tag is set for the device of a text print object
If you set a string-type label or tag for the device of a text print object, set the character code according to the type of the 
label or tag.

• System label Ver.1: ASCII code or Shift JIS code
• System label Ver.2 and global label: ASCII code, Unicode, or Shift JIS code
• OMRON NJ/NX tag: Unicode
• AB native tag: ASCII code
• OPC UA tag: Unicode

(5) Precautions for a comment print object
If the language switching device stores a nonexistent column number of the specified comment group, no comment will 
be output.
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■3 Precautions for using the report function
(1) When the collection trigger occurs during data collection

If the collection trigger for a report screen occurs again during data collection, the new collection trigger will be invalid and 
data will not be collected.
Use the Collection in-progress signal of the process notification device to check if collection is in progress per report 
screen.

➟10.11.3 ■8 (1) Collection in-progress signal
If the collection trigger for another report screen occurs during data collection, the new collection will be executed after 
the current collection is completed.

(2) When the output trigger occurs while output is in progress
If the output trigger for a report screen occurs again during output, the new output trigger will be invalid and data will not 
be output.
Use the Output in-progress signal of the process notification device to check if output is in progress per report screen.

➟10.11.3 ■8 (2) Output in-progress signal
If the output trigger for another report screen occurs during output, the new output will be executed after the current output 
is completed.
To check information on the report function (output status and the outputted screen numbers) in the project, use system 
signals.
You can use a PLC CPU to control the system signals so that output triggers will not occur simultaneously.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])
• Report Output signal (System signal 2-1.b8)
Turns on during output.

• Currently Printed Report Screen (Write device)
Stores the screen number of the report screen data being output.
The stored screen number will not be cleared upon completion of output and will be retained until the next report screen 
data is output.

The following shows how the above system signals work.

(3) Precautions for restarting the GOT
If the GOT is restarted, all report files created before the restart will be write-protected.
If you have specified a report file with devices before the restart, specify a new file after the restart for the next output.

Report screen 1
Collection trigger

OFF

ON ON

Report screen 1
Data collection process

Report screen 2
Collection trigger

Report screen 2
Data collection process

OFF

ON

×

0

ON

OFF

1

Report Output signal

Currently Printed 
Report Screen

Output status of 
report screen data The data of report screen 1 is being output.
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(4) To maintain file access performance
You are recommended to format the data storage before using it.
The number of files to be stored in a folder should be less than 500.
If 500 or more files are stored in a folder, the access performance may be lowered.
When data is repeatedly written to or deleted from the data storage, the access performance may be lowered regardless 
of the number of files.
In such a case, format the data storage.

■4 Precautions for using serial printers
In the following cases, a serial printer may not print data and a system alarm may not occur even if the Print Output signal 
(System signal 2-2.b15) is turned off.
• A printer is powered off.
• The cable of a printer is unplugged.

■5 Precautions for using Ethernet printers
(1) Precautions for printing

When a printing job is executed under the following conditions, the Printer Error Detection signal (System signal 2-1.b15) 
is turned on, and the job is canceled.
• A printer is disconnected.
• A printer is powered off.

For a PCL5 printer, the Printer Error Detection signal (System signal 2-1.b15) is not turned off automatically.
Fix the error and turn off the signal.

(2) Precautions when an error occurs in a printer
For a PCL5 printer, when an error occurs in a printer, the Printer Error Detection signal (System signal 2-1.b15) is not 
turned on.
Check the printer status and fix the error.
The printer pauses the printing and resumes the job when the error is fixed.

(3) Precautions for system alarms
For a PCL5 printer, even if the printer is powered off or the network is disconnected during printing, no system alarm may 
occur.

(4) Precautions when the Printer Error Detection signal (System signal 2-1.b15) is turned on
The data output to a printer when this signal is on is printed when the signal is turned off.
If the data is faulty, the data is deleted and the printing is canceled.
For a PCL5 printer, all printing jobs are canceled when this signal is on.

■6 Precautions for using Ethernet printers (GT21 and GS21)
(1) Precautions for printing a report

If GT21 or GS21 outputs a report to an Ethernet printer, the report will be printed in any font supported by the printer.
The font of the GOT and that on the printed output appear different.
The following lists the fonts supported by the printers.

*1 Characters may be printed incorrectly if the printer does not support the GOT's font.
*2 Alphanumerics are printed in Courier.

GOT setting
Printer font *1

Character Code KANJI region

ASCII - Courier

Unicode

Japan Andale Mono WT J *2

China(GB)-Mincho Andale Mono WT S *2

China(Big5)-Gothic Andale Mono WT T *2

S-JIS - Andale Mono WT J *2

GB - Andale Mono WT S *2

Big5 - Andale Mono WT T *2
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10
10.11.5 [Report Setting] dialog

Click [Screen] → [Report Setting] from the menu to display the [Report Setting] dialog.
When a report screen has not been created yet, the [Report Setting] dialog is not displayed.

1) [Printer Type]
Not available to GT SoftGOT2000.
The type of the printer set in the [Printer] dialog

➟10.11.8 [Printer] dialog
2) [Printer Setting] button

Not available to GT SoftGOT2000.
Displays the [Printer] dialog.
Configure the settings to connect a printer to the GOT.

➟10.11.8 [Printer] dialog
3) [Paper Size]

Not available to GT SoftGOT2000.
This item appears when [Printer Type] is set to [ESC/P-R] or [PCL5].
Select a paper size.
The following shows selectable items.

• [A4 (210x297mm)]
• [Letter (8.5"x11")]

4) [Printer Language]
Not available to GT SoftGOT2000.
This item appears when [Printer Type] is set to [Serial].
Select the language supported by the printer.
The following shows the items to be selected.

• [Japanese]
• [English]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2)

3)4)
5)

6)
7)
8)

9)

10)

When [Printer Type] is set to [Serial]

When [Printer Type] is set to [ESC/P-R] or [PCL5]
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5) [Trigger Watch Cycle]
Specify the cycle of monitoring the trigger devices of the report function. The collection trigger device, abort trigger 
device, output trigger device, and delete trigger device are included.
The setting range is [1] second to [60] seconds.
The devices that are set to each trigger should be turned on or off longer than the cycle to be set here.
When the devices are turned on or off within the cycle to be set here, a trigger may not be satisfied.

6) [Output Abort Trigger]
Select a trigger to abort an output.
This setting is not applied to GT SoftGOT2000.
The following shows the items to be selected.

• [None]
Does not use the abort trigger.

• [Rise]
Aborts an output on the rising edge of a bit device.
Specify a bit device.

• [Fall]
Aborts an output on the falling edge of a bit device.
Specify a bit device.

7) [Reset the count of the number of output lines at the time of an interrupt]
Not available to GT SoftGOT2000.
This item appears when [Printer Type] is set to [Serial].
Resets the count of output lines when an output is aborted.
A page break will be inserted upon resumption of output.
This setting is invalid under the following conditions.

• [Output Timing] is set to [When trigger condition is satisfied] in the [Action] tab in the [Screen Property] dialog.
• [Insert a page break before an output] is selected in the [Report Setting] dialog.

8) [Insert a page break before an output]
Not available to GT SoftGOT2000.
This item appears when [Printer Type] is set to [Serial].
This setting applies to the report screens where [Output Timing] is set to [At the time of data collection] in the [Action] 
tab of the [Screen Property] dialog.
Inserts a page break before the output of the current report screen if the previous output was performed as shown 
below.

• The data of a different report screen was output.
• An item ([Alarm] or [Operation Log]), which is not set for the current report screen, was output.
• Any function other than the report function performed a printer output.

Collection trigger
Bit device
(Trigger action: 
  Rise)

Trigger Watch 
Cycle
3 seconds

ON ON ON ON

3 
seconds

3 
seconds

3 
seconds

3 
seconds

3 
seconds

OFF OFF OFF

Not recognize
(OFF→OFF)

Not recognize
(OFF→OFF)

Recognize
(OFF→ON)

Recognize
(ON→OFF)
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9) [Page Layout]
The setting range when [Printer Type] is set to [PictBridge], [ESC/P-R], or [PCL5] in the [Printer] dialog applies to GT 
SoftGOT2000.

10) [Edit Page Header/Page Footer] button
Not available to GT21, GT SoftGOT2000, and GS21.
Displays the [Edit Page Header/Page Footer] dialog.
Set the contents of the page header and page footer.

➟10.11.6 [Edit Page Header/Page Footer] dialog

Item Description

[Top Margin]
Set the top margin.
The setting range is [0] lines to [31] lines.

[Page Lines]

Set the number of lines per page.
The setting range varies with the setting of [Printer Type] in the [Printer] dialog.
• [PictBridge], [ESC/P-R], or [PCL5]: [1] line to [70] lines
• [Serial]: [1] line to [127] lines

[Left Margin]

Set the left margin.
The setting range varies with the setting of [Printer Type] in the [Printer] dialog.
• [PictBridge], [ESC/P-R], or [PCL5]: [0] lines to [123] lines
• [Serial]: [0] lines to [254] lines

[Page Columns]

Set the number of columns per page.
The setting range varies with the setting of [Printer Type] in the [Printer] dialog.
• [PictBridge], [ESC/P-R], or [PCL5]: [1] line to [124] lines
• [Serial]: [1] line to [255] lines

Nov. 25, 2005 16:53:24

Model Operating 
status

MC-1

Target Actual
A1
A2

1

300 10
250 20

Product qty
Line

MC-2
A1
A2

300 60
250 80

MC-1 A1
A2

Abnormal stop 300 10
250 80

MC-2
A1
A2

300 90
250 115

MC-1 A1
A2

In inspection 300 10
250 128

MC-2
A1
A2

300 130
Running 250 180
Running
Running

Running
Running
Running

Running
Running
Running
Running

Top margin

Number of 
lines per page

Left margin Number of 
columns per page
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10.11.6 [Edit Page Header/Page Footer] dialog

In the [Report Setting] dialog, click the [Edit Page Header/Page Footer] button to display the [Edit Page Header/Page 
Footer] dialog.
For the page header and page footer, refer to the following.

➟10.11.2 ■5 Report samples and the items to be output to a report
The settings made in this dialog apply to the report screens where [Output Destination] is set to [File].

1) [Page Header], [Page Footer]
Select an item to be output in [Left section], [Center section], or [Right section] of the page header or page footer.
The following shows selectable items.

• [None]
• [Text]

Outputs the entered text.
Up to 255 characters can be entered.

• [Device]
Outputs the text that is stored in as many consecutive devices as the set value of [Maximum number of characters].
Specify the start device.
The setting range of [Maximum number of characters] varies with the setting of [Printer Type] in the [Printer] dialog.
For [PictBridge], [ESC/P-R], or [PCL5]: [1] character to [124] characters
For [Serial]: [1] to [255]
Unicode is supported.
Data will be read from the specified devices starting from the lower-order bits.
NULL is supported as the termination character.
The KANJI region for the report screen applies.

• [Date + Time]
Outputs the date and time on which a report file is printed using the file print function.
Example) 18/7/1 17:38:04
The date and time format varies with the display language.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
• [Date]

Outputs the date on which a report file is printed using the file print function.
Example) 18/7/1
The date and time format varies with the display language.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])
• [Time]

Outputs the time at which a report file is printed using the file print function.
Example) 17:38:04

• [Page]
• [Page/Pages]
• [Operator Name]

Outputs the name of the operator who has printed a report file using the file print function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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10.11.7 [Header/Footer/Repeat] dialog

Step 1 Open a report screen to set the header, footer, and repeat lines.
Step 2 Select [Screen] → [Header/Footer/Repeat] from the menu to display the [Header/Footer/Repeat] dialog.

1) [Set header]
Set the header on the current report screen.

2) [Set footer]
Set the footer on the current report screen.

3) [Body: Repeat Setting]
Set lines to be output repeatedly on the current report screen.
This item appears when [Repeat] is selected for [Output Target] in the [Format] tab in the [Screen Property] dialog of 
a report screen.

Item Description

[Start] Specify the start line and the end line of the header.
Specify a value that does not exceed the set value of the [Page Lines] in the [Report 
Setting] dialog.
The header lines cannot be set as the footer or repeat lines.

[End]

Item Description

[Start] Specify the start line and the end line of the footer.
Specify a value that does not exceed the set value of the [Page Lines] in the [Report 
Setting] dialog.
The footer lines cannot be set as the header or repeat lines.

[End]

Item Description

[Start] Specify the start repeat line and the end repeat line.
Specify a value that does not exceed the set value of the [Page Lines] in the [Report 
Setting] dialog.
The repeat lines cannot be set as the header or footer lines.

[End]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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10.11.8 [Printer] dialog

Select [Common] → [Peripheral Setting] → [Printer] from the menu to display the [Printer] dialog.

1) [Use Printer]
Enables the settings to connect a printer.

2) [Connection Type]
Select a connection type between the GOT and a printer.
The following shows selectable items.

• [USB] (GT27 and GT25 (excluding GT25-W, GT2505-V, and GT25HS-V))
• [Serial] (GT27, GT25 except GT25HS-V, GT23, GT21, GS25, and GS21)
• [Ethernet] (GT27, GT25, GT23, GT21 except GT2105-Q, GS25, and GS21)

If [Ethernet] is selected, the GOT uses the following port numbers to communicate with a printer.
• [ESC/P-R]: 515
• [PCL5]: 9100

3) [Printer Type]
Printer type corresponding to the setting of [Connection Type].
Select a printer when [Ethernet] is selected for [Connection Type].

• [ESC/P-R] (GT27, GT25, GT23, and GS25)
• PCL5] (GT27, GT25, GT23, GT21 except GT2105-Q, GS25, and GS21)

4) [Destination I/F]
This item appears when [Connection Type] is set to [USB] or [Serial].
Select a GOT interface to be used.
The following shows selectable items.

• [Standard I/F(RS232)] (For GT21-P: [Standard I/F(RS232(Back))])
• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

[Extend I/F(1st)], [Extend I/F(2nd)], and [Ex-tend I/F(3rd)] are not available for GT25-W, GT2505-V, GT25HS-V, 
GT23, GT21, GT Soft-GOT2000, GS25, and GS21.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4) 5)

When [Connection Type] is set to [USB] When [Connection Type] is set to [Ethernet]
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5) [Set IP Address]
This item appears when [Connection Type] is set to [Ethernet].
Set the IP address of the printer to be connected by Ethernet.
The setting range is [0].[0].[0].[0] to [255].[255].[255].[255].
The IP address of a printer is settable in the utility as well.

➟GOT2000 Series User's Manual (Utility)

Item Description

[Detail Setting] button

This item appears when [Connection Type] is set to [Serial].
Displaying the [Detail Setting] dialog.

• [Transmission Speed(BPS)]
Select the transmission speed.
The following shows the items to be selected.
· [4800]
· [9600]
· [19200]
· [38400]
· [57600]
· [115200]

• [Data Bit]
Select the data length.
The following shows the items to be selected.
· [7bit]
· [8bit]

• [Stop Bit]
Select the stop bit length.
The following shows the items to be selected.
· [1bit]
· [2bit]

• [Parity]
Select the type for a parity check.
The following shows the items to be selected.
· [None]
· [Even]
· [Odd]

• [Retry(Times)]
Set the number of retries to be performed when a communication error occurs.
When no response is received after the retries, the communication times out.
The setting range is [0] to [5].

• [Timeout Time(Sec)]
Set the interval for communication to time out.
The setting range is [3] to [90].

• [Delay Time(ms)]
Set the send delay time to lower the load of the network and the connected PLCs.
The setting range is [0] to [300].

• [Control Method]
Fixed to [XON/XOFF].
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10.11.9 Relevant settings

Set the relevant settings other than the specific settings for the report function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT Environmental Setting [System Information]
Select [Common] → [GOT Environmental Setting] → [System Information] from the menu.

➟5.2.5 Setting a device which controls the GOT operations or notifies the GOT status ([System Information])

■2 GOT Internal Device
➟12.1.3 GOT special register (GS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Storing the screen number of the report screen data that is being printed. [Currently Printed Report 
Screen]

Notifying that a report screen is being printed.
(System signal 2-1.b8)

[System Signal 2-1]

Aborting the printing process. 
(System signal 1-2.b15)

[System Signal 1-2]

Notifying an error of the printer during printing.
(System signal 2-1.b15)

[System Signal 2-1]

Notifying that printing is in progress.
(System signal 2-2.b15)

[System Signal 2-2]

Function Setting item

Notifying the connection status between the GOT and a printer.
The following printers are supported: PictBridge-compatible printers.

GS258.b0
(Not available to GT25-W, 
GT2505-V, GT25HS-V, GT23, 
GT21, GT SoftGOT2000, GS25, 
and GS21)

Notifying the occurrence of a warning-level error.
The following printers are supported: PictBridge-compatible printers.

GS258.b1
(Not available to GT25-W, 
GT2505-V, GT25HS-V, GT23, 
GT21, GT SoftGOT2000, GS25, 
and GS21)

Notifying the occurrence of a fatal-level error.
The following printers are supported: PictBridge-compatible printers.

GS258.b2
(Not available to GT25-W, 
GT2505-V, GT25HS-V, GT23, 
GT21, GT SoftGOT2000, GS25, 
and GS21)

Notifying that the printer is ready or not.
The following printers are supported: PictBridge-compatible printers, serial printers, and Ethernet printers.

GS258.b3
(Not available to GT 
SoftGOT2000.)

Notifying the error code of the latest error that has occurred in the printer.
The following printers are supported: Ethernet printers.

GS259
(Not available to GT 
SoftGOT2000.)

Outputting page numbers with a numerical print. GS278

Outputting the date (year) on which a report file has been printed using the file print function. GS1271

Outputting the date (month) on which a report file has been printed using the file print function. GS1272

Outputting the date (day) on which a report file has been printed using the file print function. GS1273

Outputting the time (hour) at which a report file has been printed using the file print function. GS1275

Outputting the time (minute) at which a report file has been printed using the file print function. GS1276

Outputting the time (second) at which a report file is printed using the file print function. GS1277

Outputting the total number of pages to a report file by using a numerical print object. GS1278

Outputting the name of the operator who has printed a report file using the file print function. GS1279

Changing the character code to Unicode when a CSV file is output to a virtual drive of GT SoftGOT2000.
GS522.b2
(Not available to GT27, GT25, 
GT23, GT21, GS25, and GS21)
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10
Disabling automatic page breaks when the number of output lines reaches the set value of [Page Lines] in the 
[Report Setting] dialog.

GS524.b0
(Not available to GT 
SoftGOT2000.)

Inserting a page break when GS524.b0 is on.
GS524.b1
(Not available to GT 
SoftGOT2000.)

Disabling the setting of [Number of repeats] in the [Screen Property] dialog for a report screen. GS524.b2

Changing the output destination for a report file to a Brightek’s serial printer.

GS524.b15
(Not available to GT27, GT25, 
GT23, GT SoftGOT2000, and 
GS25)

Function Setting item
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10.12 Outputting Sound with the GOT (Sound Output Function)

Not available to GT2505-V and GT25HS-V.

10.12.1 Overview of the sound output function

Not available to GT2505-V and GT25HS-V.
The sound output function outputs sounds through the audio equipment (including loudspeakers) that is connected to the 
GOT.

Example) Playing a sound when the condition of a trigger action is satisfied

When the set condition is satisfied (M0 is turned on), a specified sound file plays.

■1 Playing a sound
A sound plays when the condition of a trigger action or time action is satisfied or when a relevant switch is touched.

■2 Stopping the playback
The current playback is stopped when the condition of a trigger action is satisfied or when a relevant switch is touched.

■3 Muting or unmuting the sound
The sound is muted or unmuted when the condition of a trigger action is satisfied or when a relevant switch is touched.

10.12.2 Specifications of the sound output function

Not available to GT2505-V and GT25HS-V.

■1 System application (extended function)
To use the sound output function, a system application (extended function) of [Sound Output] is required.
Selecting [Destination I/F] in the [Sound Output] dialog incorporates the application into the package data automatically.

➟10.12.5 [Sound Output] dialog
To use the function on GT SoftGOT2000, the application is not required.

■2 Number of sound output function settings for one project
One sound output function setting is available for one project.

■3 Sound file specifications
The following shows the specifications of the sound files usable for the sound output function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

M0
OFF ON Operation starts.→

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications

File format WAV format (8.000 kHz or 16.000 kHz, 16 bits, mono)

Maximum number of registered 
sound files 500 files for one project

Maximum size of registered sound 
files in total 128 MB for one project

Maximum playback time

30 seconds for one file
For a sound file with the playback time exceeding 30 seconds, the sound is cut off after 30 
seconds.
For GT SoftGOT2000, the playback time is unlimited.
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■4 Registrable sound file types
(1) Message

The sound files of the message type are generated by converting the entered text into speech.
The speaker, speed, pitch, and volume of the voice are settable.
No sound file with the playback time exceeding 30 seconds is registrable.
To register or update the sound files of the message type, the speech synthesis license must be registered.
For registering the speech synthesis license, refer to the following.

➟10.12.4 Registration of the speech synthesis license

(2) Sound effect
The sound files of the sound effect type come with GT Designer3.

(3) Melody
The sound files of the melody type come with GT Designer3.

(4) File
User-specified WAV sound files are imported to use.
The WAV sound files (8.000 kHz or 16.000 kHz, 16 bits, mono) are imported as they are.
The WAV sound files in the following conditions are converted automatically at import.

• Sampling frequency: Any
• Number of bits: 8 bits or 16 bits
• Channel: Stereo or mono

The files are automatically converted into the WAV format (16.000 kHz, 16 bits, mono).
To import any WAV sound file other than the above, convert the file into an applicable WAV sound file by using general-
purpose audio editing software.

■5 Playback specifications
One sound file plays at a time.
While a sound file is playing, if you specify another sound file to play, operation varies depending on the specified file 
number.

(1) When the specified sound file differs from the playing one
The specified sound file is held on standby and plays after the current file has finished playing.
If you specify multiple sound files to play, the specified files play in the order in which the files are held on standby.
Up to 16 sound files are held on standby.

(2) When the playing sound file or standby sound file is specified again
The sound file specified again does not play.

■6 Functions working together with the sound output function
The sound output function is usable for the relevant functions shown below.

• Trigger action
• Time action
• Action of the switch (Sound output)
• Touch key sound of the touch switch

The following shows the availability of the operations of the sound output function by relevant function.

○: Available, -: Not available

*1 To play the preselected sound files continuously with a corresponding switch, set the playlist in a trigger action setting and 
execute the trigger action with the switch.

Relevant function
Sound output function

Play Stop Mute or unmute Continuous play of a 
playlist

Trigger action ○ ○ ○ ○

Time action ○ - - -

Action of the switch (Sound output) ○ ○ ○ -*1
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■7 Playing the preselected sound files continuously
You can select multiple sound files to play them continuously with one trigger action.

Up to 16 sound files are selectable for one trigger action.
The same sound file numbers can be specified for one trigger action.
For the setting method, refer to the following.

➟9.5 Operating a Device as a Trigger ([Trigger Action])
Stopping the current playback cancels the other sound files that are selected for the same trigger action.

10.12.3 How to use the sound output function

Not available to GT2505-V and GT25HS-V.

■1 System configuration
The following shows the system configuration of sound output.
For information on how to use the sound output function on GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

No.1

No.500 In equipment A

No.2 Operation started.
An error occurred.

・
・
・

・
・
・

Sound file list

No.500

No.1

Select sound files 
in the trigger 
action setting.

An error occurred 
in equipment A.

In equipment A, 
an error occurred.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Speaker
Connection cable

GOT
PLC

Number of 
connectable 

speakersModel Option GOT model

For connectable speakers, refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT 

SIMPLE Series (for Overseas) (GOT-A-0160)

GT15-SOUT

GT27
GT25 
(excluding 
GT25-W)

For the system 
configuration 
between the GOT 
and the PLC, refer to 
each connection 
manual.

One speaker for 
one GOT

- (Built into GOT)
GT25-W
GS25

PLCGOTSpeaker

Depends on the connection typeDepends on the specifications of the speaker

Connection cable
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■2 Setting procedure
Step 1 Connect the GOT and the speaker.

➟■1 System configuration
Step 2 Configure the settings for the sound output function in the [Sound Output] dialog.

➟10.12.5 [Sound Output] dialog
This setting is not required for GT25-W, GT SoftGOT2000, and GS25.

Step 3 To import a sound file, convert the file as necessary.
To convert the file, use general-purpose audio editing software.

Step 4 Edit or register a sound file in the [Sound File List] dialog.

➟10.12.6 [Sound File List] dialog
10.12.7 [Create New Sound File] or [Edit Sound File] dialog

Step 5 Configure the setting of the relevant function to work with the sound output function.
• Trigger action

Set the sound output for a target action.
➟9.5.6 [Trigger/Action] dialog

• Time action
Set the sound output for a target action.
➟9.6.6 [Time Action Attribute] dialog

• Action of the switch (Sound output)
Set the sound output for the action of a target switch.
➟8.2.4 [Switch] dialog

• Touch key sound of the touch switch
Configure the setting to use a specified sound file for the touch key sound.
➟10.12.8 [Touch Key Sound Setting] dialog

Step 6 Write the package data to the GOT.
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT

10.12.4 Registration of the speech synthesis license

Not available to GT2505-V and GT25HS-V.
To register or update a sound file of the message type in the [Edit Sound File] dialog, purchase and register the speech 
synthesis license (SW1DND-GTVO-M).
If the speech synthesis license is unregistered, each file is playable only in the [Edit Sound File] dialog.
For purchasing the speech synthesis license, contact your local sales office.
For registering the speech synthesis license, refer to the following.

➟GT Works Text to Speech License Registration Instructions

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.12.5 [Sound Output] dialog

Not available to GT2505-V and GT25HS-V.
This setting is not required for GT25-W and GS25.
Select [Common] → [Peripheral Setting] → [Sound Output] from the menu to display the setting dialog.

1) [Destination I/F]
Set the interface of the GOT.

• [Extend I/F(1st)]
• [Extend I/F(2nd)]
• [Extend I/F(3rd)]
• [Not connected]

For the details of the GOT interface settings, refer to the following.
➟5.7 Checking the Interface Settings of the GOT ([I/F Communication Setting])

10.12.6 [Sound File List] dialog

Not available to GT2505-V and GT25HS-V.
Select [Common] → [Sound] → [Sound File List] from the menu to display the setting dialog.
Register a sound file to play on the GOT.

1) [Find Text]
Search the sound file list for a sound file based on the search keyword.
The [Contents] column is searched.
Up to 512 characters can be entered as the search keyword.
Click the [Find Next] button to search for the next occurrence of the keyword.

2) [No.]
Registered sound file number.
Up to 500 sound files are registrable.

3) [Type]
Sound file type ([Message], [Sound Effect], [Melody], or [File]) that is set in the [Edit Sound File] dialog.

4) [Contents]
• When [Type] is set to [Message]

The contents of a sound file (message) are displayed.
• When [Type] is set to [Sound Effect] or [Melody]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
4)

5)
6)
7)
8)
9)
10)
11)
12)

13)

14)
10 - 212 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.12 Outputting Sound with the GOT (Sound Output Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
The title of a sound file is displayed.
• When [Type] is set to [File]

The file name of a sound file is displayed.
5) [Skip blank rows]

Displays only the rows where sound files are set.
6) [New] button

Displays the [Create New Sound File] dialog.
➟10.12.7 [Create New Sound File] or [Edit Sound File] dialog

Set a new sound file.
7) [Edit] button

Displays the [Edit Sound File] dialog.
➟10.12.7 [Create New Sound File] or [Edit Sound File] dialog

Edit a selected sound file.
8) [Copy] button

Copies a selected row.
Multiple rows can be copied at once.

9) [Paste] button
Pastes a copied row on a selected row.
Multiple rows are pasted on an equal number of consecutive rows, starting from a selected row.
When [Skip blank rows] is selected, clicking the [Paste] button displays the [Copy Sound File] dialog.

If the destination row has a sound file setting, the [Confirm Sound Overwrite] dialog appears.

10) [Delete] button
Deletes a selected sound file.

11) [Play] button
Plays a selected sound file.

12) [Stop] button
Stops the current playback.

13) [Time]
Displays the playback time of a selected sound file.

14) [Total Size]
Displays the total size of the registered sound files.
Make sure that the total size of the files is 128 MB or less.

• [File No.]
Set the file number of the destination row.
The setting range is [1] to [500].

• [First File No.]
Set the file number of the first destination row.
The setting range is [1] to [500].

• [Yes]
Overwrites the row where the sound file specified in this dialog is set.

• [Overwrite All]
Overwrites all the rows.

• [No]
Does not overwrite the row where the sound file specified in this 
dialog is set.

• [Cancel]
Cancels the paste on the rows, starting from the one where the 
sound file specified in this dialog is set.

When one row is copied

When multiple rows are copied
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10.12.7 [Create New Sound File] or [Edit Sound File] dialog

Not available to GT2505-V and GT25HS-V.
Create or edit a sound file.
The dialog name varies with the display method.
To display this dialog, perform one of the following operations.

• In the [Sound File List] dialog, click the [New] button.
• In the [Sound File List] dialog, select a target sound file and click the [Edit] button.
• In the [Sound File List] dialog, double-click a target sound file.

1) [File No.]
Set a sound file number.
The setting range is [1] to [500].

2) [Type]
Select a sound file type.
The following shows the items to be selected.

• [Message]: Sound file that is generated by converting the entered text into speech
• [Sound Effect]: Sound file that is supplied with GT Designer3
• [Melody]: Sound file that is supplied with GT Designer3
• [File]: User-specified WAV sound file to be imported

To register or update the sound files of the message type, the speech synthesis license must be registered.
For registering the speech synthesis license, refer to the following.

➟10.12.4 Registration of the speech synthesis license
3) Detail setting

Set necessary items according to the selection for [Type].

Item Description

[Speaker]

Select the speaker to read aloud a message.
The following shows the items to be selected.
• [Japanese (female)]
• [Japanese (male)]
• [English (female)]
• [English (male)]
• [Simplified Chinese (female)]
• [Simplified Chinese (male)]
• [Traditional Chinese (female)]
• [Korean (female)]
• [Korean (male)]
• [Spanish (female)]
• [Spanish (male)]

[Speed]
Set the speed of the synthesized voice.
The setting range is [50] (Slow) to [400] (Fast).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

When [Message] is selected for [Type]

When [Sound Effect] is selected for [Type]

When [Melody] is selected for [Type]

When [File] is selected for [Type]
4)
5)

6)

2)
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4) [Play] button
Plays the sound file being edited.

5) [Stop] button
Stops the current playback.

6) [Time]
Displays the playback time of the sound file being edited.

• When [Type] is set to [Message]
The sound file whose playback time exceeds 30 seconds is not registrable.
The playback time exceeding 30 seconds is displayed in red.

10.12.8 [Touch Key Sound Setting] dialog

Not available to GT2505-V and GT25HS-V.
Select [Common] → [Sound] → [Touch Key Sound Setting] from the menu to display the setting dialog.
Configure the setting to play a sound file when a relevant touch switch is touched.

1) [Use a sound file for touch key sound]
Plays a sound file when a relevant touch switch is touched.
Perform one of the following operations to select a sound file.

• Enter a sound file number.
• Click the [Browse] button to display the [Sound File List] dialog, and select a sound file.

2) [Give top priority to touch key sound]
Stops the current playback, cancels all standby sound files and plays the touch key sound when a relevant touch 
switch is touched.

[Pitch]
Set the pitch of the synthesized voice.
The setting range is [50] (Low) to [200] (High).

[Volume]
Set the volume of the synthesized voice.
The setting range is [1] (Small) to [500] (Large).

[Message]
Enter a message to be read aloud.
Up to 1024 characters can be set.
A line feed is counted as two characters.

[Sound Effect] Select a sound effect to play.

[Melody] Select a melody to play.

[File Name]
Select a sound file to play.
Click the [Import] button to display the [Open] dialog.
Select a file to be imported to GT Designer3.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
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10.12.9 Precautions

Not available to GT2505-V and GT25HS-V.
This section explains the precautions for using the sound output function.

■1 Precautions for drawing
(1) Updating a WAV sound file

The imported WAV sound file in the [Edit Sound File] dialog is not updated when you make a change to the import source 
file.
In such a case, import the source file again.

(2) Using the sound files of the sound effect type or melody type
Do not use the sound files of the sound effect type or melody type that are settable in the [Edit Sound File] dialog for any 
purpose other than the GOT sound output.

■2 Precautions for using GT SoftGOT2000
(1) Mute status of GT SoftGOT2000 at its startup

If you select [Unmute when starting GT SoftGOT2000] on the [Auxiliary Setup] tab in the [Environment Setup] dialog on 
GT SoftGOT2000, the application is unmuted regardless of Windows sound settings.
If you deselect the item, the Windows sound settings are applied.
However, if you mute all sounds on Windows, GT SoftGOT2000 remains mute.

10.12.10 Relevant settings

Not available to GT2505-V and GT25HS-V.
Set the relevant settings other than the specific settings for the sound output function as required. The following shows 
the functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item Supported 
models

Stopping the current playback.
The standby sound file plays subsequently.

GS518.b0

Stopping the current playback and canceling all standby sound files. GS518.b1

Muting or unmuting the sound. GS518.b2

Outputting the sound file number in execution to a device GS669

Detecting the jack disconnection of the sound output device GS668.b15

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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10.13 Monitoring a Controller through a GOT (Server/Client Function)

10.13.1 Overview of the server/client function

The server and client functions enable you to perform monitoring and maintenance remotely from an office.
You can access a GOT or GT SoftGOT2000 having the server function (hereafter "GOT (server)") through a client device, 
and easily collect or change device data of the controllers monitored by the GOT (server).
The following devices can be used as a client are supported.
• Personal computer on which MX Component is installed (hereafter "personal computer (MX Component)")
• Personal computer on which GENESIS64 is installed (hereafter "personal computer (GENESIS64)")
• GOT to which the client function is granted (hereafter "GOT (client)")
A personal computer (client) is used hereafter as a generic term for a personal computer (MX Component) and a personal 
computer (GENESIS64).

■1 Collecting or changing device data on a personal computer (client) (server function)
When you use a personal computer (MX Component) as a client, GT SoftGOT2000 cannot be a server.
When you use a personal computer (GENESIS64) as a client, GOT1000 cannot be a server.
You can read/write device data of the controllers monitored by a GOT (server) on a personal computer (client) connected 
to Ethernet.
Use the server function, and you can monitor multiple controllers on a personal computer by connecting the personal 
computer to a GOT (server) by Ethernet. The function has eliminated the need for establishing communications with 
controllers in their respective communication formats or installing the OPC UA server.
The function is available by installing MX Component or GENESIS64.
Communication settings for each controller is not required on the personal computer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Company A PLC Microcomputer boardMITSUBISHI PLC

Ethernet

Personal computer 
(client)

RS-232 
communication

RS-422 
communication

RS-422 
communication

GOT
(server)

GOT
(server)

GOT
(server)
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.13 Monitoring a Controller through a GOT (Server/Client Function)

10 - 217



■2 Collecting or changing device data monitored by another GOT on a GOT (server and client 
functions)

GT SoftGOT2000 supports the server function but does not support the client function.
You can read/write device data of the controllers monitored by a GOT (server) by accessing the GOT (server) through a 
GOT (client) connected to Ethernet.
This enables you to monitor device data of different manufacturers' controllers collectively on one GOT (client).
One GOT (client) can be connected to up to 128 GOTs (servers).

■3 Using the server and client functions in one GOT
Not available to GT SoftGOT2000.
The server and client functions can be used in one GOT.
When a GOT has the server and client functions, while collecting data of another GOT (server) you can send the data to 
a personal computer (client) or another GOT (client) through the GOT.

■4 Communications between the GOT2000 series and GOT1000 series
When GT SoftGOT2000 is the server, communications with the GOT1000 series (client or server) are not available.
When the server or client function is used in a personal computer (MX Component), the GOT1000 series, and the 
GOT2000 series, communications are available among them.
You can add the GOT2000 series to the existing system configured with the GOT1000 series or replace the GOT1000 
series with the GOT2000 series.

RS-232 
communication

RS-422 
communication

RS-422 
communication

Company A PLC Microcomputer boardMITSUBISHI PLC

Ethernet

GOT 
(client)

GOT
(server)

GOT
(server)

Ethernet

GOT
server
＋

client

RS-232 
communication

RS-422 
communication

RS-422 
communication

Personal computer
(client)

Company A PLCMicrocomputer board MITSUBISHI PLC

GOT 
(client)

GOT
(server)

RS-422 
communication

MITSUBISHI PLC

RS-422 
communication

Microcomputer board

RS-232 
communication

Company A PLC

Ethernet

GOT
2000

GOT
1000

GOT
1000
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■5 Flow of data
To collect or change device data of a controller monitored by a GOT (server) through a client, set the assignment 
definition of the virtual gateway devices and the corresponding devices of the monitored controller on the GOT (server).
Then, you can access the gateway devices of the GOT (server) through the client and read/write the data of the controller 
devices assigned to the gateway devices.
Data is exchanged using the gateway devices set in the GOT (server).
There is no need to consider the manufacturer and model of the monitored controller.

The following shows the flow of data when device data of a controller connected to a GOT (server) is read to a client.
Example) Reading the value of the controller's device [D300] to a client

Step 1 The client makes a request for the value of the gateway device [EG1] to the GOT (server).
Step 2 The GOT (server) searches for the controller device assigned to the gateway device [EG1] based on the 

assignment definition of the gateway devices and controller devices.
Step 3 The GOT (server) reads the value [500] of the assigned device [D300] from the controller.
Step 4 The client obtains the value [500] read by the GOT (server).

How to access the gateway devices of the GOT (server) through a client depends on the client type.
Personal computer (MX Component): Use functions of MX Component.
Personal computer (GENESIS64): Use GENESIS64 tags.
GOT (client): Use the script function or device data transfer function.
For the details, refer to the following.

➟10.13.3 ■3 How to access the gateway devices of a GOT (server) from a personal computer (MX Component)
10.13.3 ■4 How to access the gateway devices of a GOT (server) from a personal computer (GENESIS64)
10.13.3 ■5 How to access the gateway devices of a GOT (server) from a GOT (client)

Controller
Requesting the value of 
the gateway device [EG1]

Obtaining the device value [500]

Assignment
definition D100  =  250

D200  =  300
D300  =  500
　     ：

Searching the assignment 
definition for the device 
corresponding to [EG1]

Reading the value 
of the assigned 
device [D300]EG0  =  D200

EG1  =  D300
EG2  =  D500
　　 ：

GOT
(server)

Personal computer
(client)

Client

GOT
(client)

Gateway
device

Controller
devices

1.

1.

2.

3.

4.

4.
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10.13.2 Specifications of the server/client function

■1 System application (extended function)
To use the server/client function, a system application (extended function) of [Gateway(Server, Client)] is required.
Configuring the following settings in the [Controller Setting] window incorporates the application into the package data 
automatically.
• [Gateway Server]
• [Gateway Client]

➟10.13.6 [Gateway Server]
10.13.7 [Gateway Client]

■2 Number of server/client functions for one project
One server function setting and one client function setting are available for one project.

■3 GOTs and software applications usable as a server or client
The following GOTs and software applications can be used as a server or client.

• Server: GT27, GT25, GT SoftGOT2000, and GS25
• Client: GT27, GT25, GS25, MX Component, and GENESIS64 (GENESIS64 Advanced or GENESIS Basic SCADA)

The following shows availability of server/client combinations.
○: Available
×: Not available

■4 Specifications of the servers and clients
The following shows the specifications of the server/client function.

*1 When six or more clients (GOTs and personal computers) access a server (GOT), the scripts of the clients may stop.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Server Client Availability

GT27, GT25, GS25

GT27, GT25, GS25 ○

MX Component ○

GENESIS64 ○

GT SoftGOT2000

GT27, GT25, GS25 ○

MX Component ×

GENESIS64 ○

Item Specifications

Port No.
Server function

• GT27, GT25, GS25: 5011
• GT SoftGOT2000: 1024 to 65534

Client function 5012, 5013

Maximum number of nodes

The total number of the following nodes is 64 (recommended).
• GOTs (server)
• GOT (client)
• Personal computers that communicate with GOTs

Number of accessible clients (GOTs and personal 
computers) to a server (GOT) simultaneously Up to 5 units *1

Specifying other nodes Specifying by an IP address, up to 128 nodes

Gateway device Word device 32768 points: EG0 to EG32767

Compatible MX Component MX Component of Version 3 or later

Compatible GENESIS64 10.97.1 or later
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■5 Access range that can be monitored
The following shows the access range for the server/client function.
To monitor controllers via the GOT, monitor the controller devices assigned to gateway devices. (Controller devices on the 
network are to be also assigned to gateway devices to get monitored.)
The access range that can be monitored is the same as that which the GOT can monitor.
For the access range that can be monitored by the GOT, refer to the following.

➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1
The following shows the PLCs that can be accessed from GOT1 (client) and the personal computer (client).
For the applicable connection types when GT SoftGOT2000 is a server, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

(1) When the connection type between GOT2 (server) and PLC1 is the direct CPU connection (serial) or 
serial communication connection

(2) When the connection type between GOT2 (server) and PLCs is a CC-Link connection (via G4)

Access source
Access destination

GOT2 (server) PLC1, PLC2,
PLC3, PLC4

Personal computer (client) Monitoring the gateway devices or the controller 
devices

Monitoring the controller devices that are assigned to the 
gateway devices of GOT2 from the personal computer 
(client) and GOT1 (client)GOT1 (client)

Server

Ethernet

Client

Personal computer 
(client) 

GOT 1 GOT 2

RS-232 or 
RS-422 

communication

PLC 1

Connected with MELSECNET/H 
or other networks

PLC 2

PLC 3 PLC 4

Access source
Access destination

GOT2 (server) PLC1, PLC2,
PLC3

Personal computer (client) Monitoring the gateway devices or the controller 
devices

Monitoring the controller devices that are assigned to the 
gateway devices of GOT2 from the personal computer 
(client) and GOT1 (client)GOT1 (client)

Server

Ethernet

Client

Personal computer 
(client) 

GOT 1 GOT 2

RS-232 or 
RS-422 

communication

CC-Link

PLC 1

PLC 2 PLC 3

AJ65BT-G4-S3
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(3) When the connection type between GOT2 (server) and PLCs is an Ethernet connection

(4) When the connection type between GOT2 (server), PLCs, and a temperature controller is another 
manufacturer's PLC connection

10.13.3 How to use the gateway devices

The gateway device is a virtual device exclusively used to perform the server/client function on the GOT.

■1 Applicable gateway devices
The following shows the applicable gateway devices.

■2 Devices that can be assigned
You can assign the following devices to gateway devices (EG).
• Controller devices that can be monitored by the GOT
• GOT internal devices
However, some controller devices cannot be assigned.
For information on which device can be assigned, refer to the following.

➟12.3 Device Range and Settings of Mitsubishi Electric Equipment
12.4 Device Range and Settings of Each Controller

Access source
Access destination

GOT2 (server) PLC1 PLC2, PLC3, PLC4

Personal computer (client)
Monitoring the gateway devices or the controller 
devices

Monitoring the gateway devices or the controller devices 
from a personal computer (client) and GOT1 (client)

GOT1 (client)
Monitoring the controller devices that are assigned to the 
gateway devices of GOT2 from the personal computer 
(client) and GOT1 (client)

Server

Ethernet

Client

Personal computer 
(client) 

GOT 1 GOT 2
PLC 1

Connected with MELSECNET/H 
or other networks

PLC 2

PLC 3 PLC 4

Access source
Access destination

GOT2 (server) PLC, temperature controller

Personal computer (client) Monitoring the gateway devices or the controller 
devices

Monitoring the controller devices that are assigned to the 
gateway devices of GOT2 from the personal computer 
(client) and GOT1 (client)GOT1 (client)

Server

Ethernet

Client

Personal computer 
(client) 

GOT 1 GOT 2 Company A PLC

RS-232 or 
RS-422 

communication

Device name Device range Device No. representation

Word device EG EG0 to EG32767 Decimal number

Bit device EG Specified bits of above word devices Decimal number
10 - 222 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.13 Monitoring a Controller through a GOT (Server/Client Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
■3 How to access the gateway devices of a GOT (server) from a personal computer (MX 
Component)

Use the functions of MX Component to access the gateway devices of a GOT (server) from a personal computer (MX 
Component).

For the operation and the programming procedures of MX Component, refer to the following manuals.
➟MX Component Version 3 Operating Manual
MX Component Version 3 Programming Manual

The following shows the functions of MX Component that support the GOT.

Item Device range

Open Opens the communication line (starts the communication with the GOT).

Close Closes the communication line (ends the communication with the GOT).

ReadDeviceBlock
Device batch read

ReadDeviceBlock2

WriteDeviceBlock
Device batch write

WriteDeviceBlock2

ReadDeviceRandom
Device random read

ReadDeviceRandom2

WriteDeviceRandom
Device random write

WriteDeviceRandom2

EntryDeviceStatus Device status observation registration

FreeDeviceStatus Cancels device status observation registration.

OnDeviceStatus Event notification

SetDevice
Changes device data values.

SetDevice2

GetDevice
Obtains device data values.

GetDevice2

GetCpuType Obtains GOT model information.

Server Server

Ethernet

MITSUBISHI PLC OMRON PLC
Personal computer
(MX Component)

Access to the gateway devices

Assignment 
definition 
EG0=D100

D100: 250 TIM50: 330

Assignment 
definition 
EG0=TIM50

• MITSUBISHI PLC 
   D100        250 
• OMRON PLC 
   TIM50       330
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■4 How to access the gateway devices of a GOT (server) from a personal computer 
(GENESIS64)

Establish correlation between the GENESIS64 tags and the GOT gateway devices to access the gateway devices of a 
GOT (server) from a personal computer (GENESIS64).
You can establish correlation between the GENESIS64 tags and the GOT gateway devices manually in GENESIS64 or 
by using the label information for GT Designer3.
For details, refer to the following.

➟10.14.1 Overview of the GENESIS interaction function

Access to the gateway devices

Ethernet

Personal computer
(GENESIS64)

・MITSUBISHI PLC
D100 250

・Company A PLC
TIM250 520

GOT
(server) Assignment

definition
EG50=TIM250

Label definition
Label20=EG50

TIM250: 520

Company A PLC

GOT
(server) Assignment

definition
EG0=D100

Label definition
Label10=EG0

D100: 250

MITSUBISHI PLC

Tag setting
・Setting the tags manually
・Using the label information 

of GT Designer3

Label10=EG0
Label20=EG50
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10
■5 How to access the gateway devices of a GOT (server) from a GOT (client)
Use the script function or device data transfer function of the GOT (client) to access the gateway devices of a GOT (server) 
from a GOT (client).

➟9.4 Transferring Data between Devices ([Device Data Transfer])
➟9.8 Controlling Operations with Scripts ([Script])

The following explains how to access the gateway devices using the script function.
Object scripts cannot be used since the gateway devices cannot be assigned to objects.
Use a project script or screen script.

(1) When reading the value of a gateway device
Using a script reads the value of a gateway device of a GOT (server) to an internal device of a GOT (client).
You can monitor the value read to the internal device using a numerical display object or others on the GOT (client).
For details on scripts, refer to the following.

➟9.8 Controlling Operations with Scripts ([Script])

The following shows the settings required for a GOT (client) and a GOT (server).

GOT Required setting Description

GOT (server) Server setting Configures the setting for assigning the device of the company A PLC CPU to the gateway 
device.

GOT (client)

Script Configures the setting to read the gateway device value of the GOT (server) to internal device 
of the GOT (client).

Client setting Registers the GOT (server) from which the client reads the device value.

Numerical display Configures the setting for displaying the internal device value of the GOT (client).

Ethernet

GOT 
(client)

Company A PLC

GOT
(server)

・Company A PLC
TIM50 520

TIM50: 520

GOT internal device
GD100: 520

With the script function, 
GD100 reads the value of EG0. 
[w:GD100]=[1-1:w:EG0];

Assignment 
definition 
EG0=TIM50

The value of GD100 is displayed
on a numerical display object.
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(2) When writing a value to the gateway device.
Write the value of the internal device of the GOT (client) to the gateway device of the GOT (server) by using a script.
Write the value to the GOT (client) internal device using a numerical input object or others.
A device of the GOT (server) can be also set as a destination for writing by the script.

GOT Required setting Description

GOT (server) Server setting Configures the setting for assigning the device of the company A PLC CPU to the gateway 
device.

GOT (client)

Script Configures the setting to write the internal device value of GOT (client) to the gateway device 
of the GOT (server).

Client setting Registers the GOT (server) to which the value is written.

Numerical input Configures the setting for entering the value of the GOT (client) internal device.

Ethernet

GOT 
(client)

GOT
(server)

Company A PLC
TIM50 520

TIM50: 520

GOT internal device
GD100: 520

Company A PLC

Assignment 
definition 
EG0=TIM50

With the script function,
the value of GD100 is written to EG0. 
[1-1:w:EG0]=[w:GD100];

The value is stored to GD100
using a numerical input object.
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10.13.4 How to use the server/client function

■1 System configuration
This section explains the system configuration of the server/client function.

(1) Wired connection

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Client
(GOT, personal computer)

Connection cable*1*2
Maximum 
segment 
length*3

Server (GOT)

GOT model or personal 
computer Option Option GOT

GT27
GT25
GS25

- (Built in the GOT)

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded 
twisted pair cable (UTP): Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 
5e

100m

- (Built in the GOT)
GT27
GT25
GS25

GT27
GT25 GT25-J71E71-100 *4

GT25-J71E71-100 *4 GT27
GT25

-

Following 
devices with GT 
SoftGOT2000 
installed *5

• Personal 
computer

• PC CPU 
module

• MELIPC

Personal computers 
where MX Component 
is installed

-

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded 
twisted pair cable (UTP): Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 
5e

100m -

GT27
GT25
GS25

Personal computers 
where GENESIS64 is 
installed

GT27
GT25
GS25
Following 
devices with GT 
SoftGOT2000 
installed *5

• Personal 
computer

• PC CPU 
module

• MELIPC

GOT PLCGOT
Personal computer

(client)

Client Server
Depends on 

the connection 
type

Connection cable
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• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)
For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Not available to GT2505-V and GT25HS-V.
*5 To use a personal computer, an Ethernet board/card is required.

For Ethernet boards/cards, refer to the following.
➟GT SoftGOT2000 Version1 Operating Manual

To use a PC CPU module or MELIPC, no interface board is required.
For the system configuration, refer to the following.
➟Manual of the PC CPU module used

User's manual of MELIPC

(2) Wireless LAN connection
Not available to GT2505-V and GT25HS-V.

Client
(GOT, personal computer)

Wireless LAN access point
GOT (server)

GOT model or personal 
computer Option Option GOT

GT27*2

GT25*2

GS25*2

GT25-WLAN

-

GT25-WLAN
GT27*1

GT25*1

GS25*1

-

Following 
devices with GT 
SoftGOT2000 
installed
• Personal 

computer
• PC CPU 

module
• MELIPC

• Wireless LAN access point
For the connectable wireless LAN access points and system devices, 
refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT 

SIMPLE Series (for Overseas) (GOT-A-0160)

GT25-WLAN
GT27*2

GT25*2

GS25*2

-

Following 
devices with GT 
SoftGOT2000 
installed
• Personal 

computer
• PC CPU 

module
• MELIPC

Personal computers 
where MX Component is 
installed

-

- GT25-WLAN
GT27*1

GT25*1

GS25*1

• Wireless LAN access point
For the connectable wireless LAN access points and system devices, 
refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT 

SIMPLE Series (for Overseas) (GOT-A-0160)

GT25-WLAN
GT27*2

GT25*2

GS25*2

GOT PLCGOT
Personal computer

(client)

Client

Wireless LAN
access point

Server
Depends on 

the connection 
type
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*1 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*2 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

Personal computers 
where GENESIS64 is 
installed

-

-

GT25-WLAN
GT27*1

GT25*1

GS25*1

-

Following 
devices with GT 
SoftGOT2000 
installed
• Personal 

computer
• PC CPU 

module
• MELIPC

• Wireless LAN access point
For the connectable wireless LAN access points and system devices, 
refer to the following Technical News.
➟List of Valid Devices Applicable for GOT2000 Series and GOT 

SIMPLE Series (for Overseas) (GOT-A-0160)

GT25-WLAN
GT27*2

GT25*2

GS25*2

-

Following 
devices with GT 
SoftGOT2000 
installed
• Personal 

computer
• PC CPU 

module
• MELIPC

Client
(GOT, personal computer)

Wireless LAN access point
GOT (server)

GOT model or personal 
computer Option Option GOT
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■2 Setting procedure
Step 1 Consider the configuration of the whole system.

• Configuration of the whole system including controllers and GOTs
• Controller settings (including device assignment)
• GOT settings (including IP address, network number, and station number)

To use GT SoftGOT2000 as a server, configure the firewall setting.
For details, refer to the following.

➟■3 Firewall setting
Step 2 Connect the GOT and the controllers.

➟■1 System configuration
Step 3 Configure the communication interface settings in the project for the server.

To use the GOT as a client, configure the settings in the project for the client.
➟10.13.5 [Communication Setting]

To use GT SoftGOT2000 as a server, configure the relevant settings in the [Communication Setup] dialog 
in GT SoftGOT2000.

➟GT SoftGOT2000 Version1 Operating Manual
Step 4 Set the IP address of the GOT.

➟5.4.1 ■3 [GOT IP Address Setting]
Step 5 Configure the gateway server settings in the project for the server.

➟10.13.6 [Gateway Server]
Step 6 To use the GOT as a client, configure the gateway client settings in the project for the client.

➟10.13.7 [Gateway Client]
Step 7 To use a personal computer (GENESIS64) as a client, configure the settings to enable GENESIS64 

interaction with the GOT.
For details, refer to the following.

➟10.14 Monitoring a Controller through a GOT Using GENESIS64 (GENESIS Interaction Function)
Step 8 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 9 Check the GOT operation.

➟10.13.8 Server/client function application example
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■3 Firewall setting
To use GT SoftGOT2000 as a server, change the firewall setting.
The following shows the setting procedure.

Step 1 In [Control Panel], select [System and Security] → [Windows Defender Firewall] to display the [Windows 
Defender Firewall] dialog.

Step 2 Click [Allow an app or feature through Windows Defender Firewall] on the left of the dialog to display the 
[Allowed apps] dialog.

Step 3 Click the [Change settings] button.
Step 4 In [Allowed apps and features], select the following options for [GOT2000 Series Software GOT.].

• [Private]
• [Public]

If [GOT2000 Series Software GOT.] is not listed, click the [Allow another app] button and add 
"GTSoftGOT2000.exe".
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10.13.5 [Communication Setting]

To use GT SoftGOT2000 as a server, configure the gateway function settings in the [Communication Setup] dialog in GT 
SoftGOT2000.
For the settings in GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual
Configure the following communication settings in the project for the server and in the project for the client.

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [Communication Setting] in the [Controller Setting] window and set necessary items.

1) [Use the function of Gateway]
Select this item when using the client or server function.

2) [Detail Setting]
Set the detailed communication format.
The setting range depends on controllers.
For the details of the settings, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

Item Description

[GOT Net No.] Set the network No. of the GOT.

[GOT Station] Set the GOT's station number.

[GOT Communication Port No.]
Set the port No. used by the GOT for the connection with the Ethernet module.
Do not set the port number used for the other settings.
Duplication of the port number disables communication.

[Retry(Times)] Set the number of retries to be performed when a communication error occurs.
When no response is received after the retries, the communication times out.

[Startup Time(Sec)] Set the time period from the GOT startup to the beginning of the communication with the 
PLC CPU.

[Timeout Time(Sec)] Set the interval for communication to time out.

[Delay Time(ms)] Set the send delay time to lower the load of the network and the connected PLCs.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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10.13.6 [Gateway Server]

Set the gateway devices used in the GOT (server) and the controller devices to be assigned to the gateway devices in 
the project for the server.

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [Gateway-Server] in the [Controller Setting] window, and set the necessary items.

1) Assignment setting list
Assign the controller devices to the gateway devices.

2) [New] button
Adds a new assignment setting to the list.

3) [Duplicate] button
Adds the copy of a selected assignment setting to the list.

4) [Delete] button
Deletes a selected assignment setting.

Item Description

[EG Device] Set the gateway device.
The setting range is [0] to [32766].

[Type]

Select the device type to be assigned.
The following shows the items to be selected.
• [BIT]
• [WORD]

[PLC Device]

Set the controller devices to be assigned to the gateway devices.
When the multi-channel function is used, the devices of channel No. 2 to 4 are displayed 
in a channel No. + Device.

For how to set the devices, refer to the following.
➟6.1.2 How to set devices

[Points]

Set the number of the devices to be assigned.
The following shows the setting ranges of [BIT] and [WORD] selected in [Type].
• [BIT]: [32] to [32768]
• [WORD]: [2] to [32768]
A value outside the above ranges cannot be set.
➟10.13.10 ■5 Precautions for assigning devices

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
4)

5)

6)
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5) [Delete All] button
Deletes all assignment settings.

6) [Check] button
Checks if the settings are correct.

10.13.7 [Gateway Client]

Register the GOTs (servers) to be monitored in the project for the client.
Up to 128 GOTs (servers) can be registered.

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [Gateway Client] in the [Controller Setting] window, and set the necessary items.

1) GOT list for the server function
Register the GOTs (server) to be monitored by the GOT (client).

2) [New] button
Adds a new GOT (server).

3) [Duplicate] button
Adds the copy of a selected GOT (server).

4) [Delete] button
Deletes a selected GOT (server).

5) [Delete All] button
Deletes all GOTs (server).

Item Description

[Net No.] Register the network No. of each GOT.
The setting range is [1] to [239].

[Station No.] Register the PLC No. (station number) of each GOT.
The setting range is [1] to [64].

[Type]
Register the type of the GOT used as a server.
• [GOT]
• [SoftGOT]

[IP Address] Register the IP address of each GOT.
The setting range is [0.0.0.0] to [255.255.255.255].

[Port No.]
The setting range depends on the selection for [Type].
• [GOT]: Fixed to [5011]
• [SoftGOT]: [1024] to [65534]

[Communication] Fixed to UDP.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)
4)
5)
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10.13.8 Server/client function application example

To apply the example programs in this section to the actual system, make sure that the programs cause no troubles in 
the target system.

■1 Monitoring the PLC devices on a personal computer (MX Component) through a GOT
Monitor the values of the PLC devices D10 to D15 on a personal computer (MX Component) through a GOT (server).

Access EG0 to EG5 of the GOT (server) on the personal computer (MX Component).

(1) Setting example of GOT (server)
(a) Settings for [Gateway Server]

(2) Personal computer setting
Access the GOT (server) by using MX Component.
For the details of MX Component, refer to the following.

➟MX Component Version 3 Operating Manual
MX Component Version 3 Programming Manual

■2 Displaying the alarms occurred in multiple PLCs on the GOT (client)

Step 1 Transfer the device values of PLC2 and PLC3 to the internal devices of GOT1 (GD100 to GD147).
Step 2 GOT1 monitors its own internal devices and displays the alarm information when an alarm occurs in PLC2 

or PLC3.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT
(server)

Ethernet

Personal computer 
(MX Component) 

PLC

D10 to D15 of PLC 
are monitored. 
D10: 150 D11: 480
D12: 230 D13: 370
D14: 80  D15: 25

Device values of PLC 
D10: 150 D11: 480
D12: 230 D13: 370
D14: 80  D15: 25

EG0 to EG5 of 
GOT (server) are monitored. 
EG0: 150 EG1: 480
EG2: 230 EG3: 370
EG4: 80  EG5: 25

EG device PLC CPU device Device type Points

EG0 D10 Word 6

Ethernet

PLC 1

Client

PLC 3PLC 2

Server 
+ 

Client

GOT 1

GOT 2 GOT 3

For other settings, refer to 
(2) Setting example of GOT 2.

For other settings, refer to 
(1) Setting example of GOT 1.

For other settings, refer to 
(3) Setting example of GOT 3.

GOT utility 
GOT NW No.: 1
GOT PC No.: 1 
IP address: 192.168.0.18

GOT utility 
GOT NW No.: 1
GOT PC No.: 2 
IP address: 192.168.0.19

GOT utility 
GOT NW No.: 1
GOT PC No.: 3 
IP address: 192.168.0.20

Transferred by script 1 
(cycle of 5 seconds)

Transferred by 
script 2 (cycle of 5 seconds)

1.
3.

2.

GOT 1 internal device
GD100 to 131
GD132 to 147

Server 
+ 

Client
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(1) Setting example of GOT1
(a) Settings for [Gateway Client]

(b) Alarm display (alarm display for GOT2)
Set the comments that are displayed in the alarm display in advance.

(c) Alarm display (alarm display for GOT2)
Set the comments that are displayed in the alarm display in advance.

(d) Script (alarm display for GOT2)

(e) Script (alarm display for GOT3)

(2) Setting example of GOT2
(a) Settings for [Gateway Server]

(3) Setting example of GOT3
(a) Settings for [Gateway Server]

Trigger type
Do not set [Ordinary] or [Sampling, 2 sec.] for the trigger type in the script. The setting may affect other 
monitoring operations.

N/W No. Station No. IP address

1 2 192.168.0.19

1 3 192.168.0.20

Item Description

Device points (number of alarms) 512 points (successive)

Device GD100.b0

Item Description

Device points (number of alarms) 256 points (successive)

Device GD132.b0

Item Description

Script 1

Type Screen script

Trigger type Cycle: 5 seconds

Data type Unsigned BIN 16

Example of script description
bmov([1-2:w:EG0],[w:GD100],32);
//Transfers 32 points from EG0 of GOT2 to GD100 and the following 
successive devices of GOT1

Item Description

Script 2

Type Screen script

Trigger type Cycle: 5 seconds

Data type Unsigned BIN 16

Example of script description
bmov([1-3:w:EG0],[w:GD132],16);
//Transfers 16 points from EG0 of GOT 3 to GD132 and the following 
successive devices of GOT1

EG device PLC CPU device Device type Points

EG0 IB200 Bit 512

EG device PLC CPU device Device type Points

EG0 ..300 Bit 256
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■3 Monitoring and controlling the production status of multiple PLCs on the GOT (server)

Step 1 Transfer the device values of PLC2 and PLC3 to the EG devices (devices of PLC 1) of GOT1 (server).
Step 2 After the values are written to PLC1, the EG devices of GOT1 (internal devices (GB128, GB129) of GOT1 ) 

turn on. (Check a lamp or other indications to see if the writing is complete.)
Step 3 GOT1 (server) checks the production status of PLC2 and PLC3 by monitoring the devices of PLC1.

(1) Setting example of GOT1
(a) Settings for [Gateway Server]

(b) Numerical display (setting for 2 devices)

(c) Lamp (setting for 2 devices)

(2) Setting example of GOT2
(a) Settings for [Gateway Client]

Ethernet
PLC 1

Server

PLC 3

GOT 1

GOT 3For other settings, refer to 
(2) Setting example of GOT 2.

For other settings, refer to 
(1) Setting example of GOT 1.

For other settings, refer to 
(3) Setting example of GOT 3.

GOT utility 
GOT NW No.: 1
GOT PC No.: 1 
IP address: 192.168.0.18

GOT utility 
GOT NW No.: 1
GOT PC No.: 2 
IP address: 192.168.0.19

GOT utility 
GOT NW No.: 1
GOT PC No.: 3 
IP address: 192.168.0.20

PLC 1 devices

2.

1.
1.

3.

PLC 2

GOT 2

Client Client

When the bit device that indicates production 
completion turns on, the value of HR200 (233) 
is transferred to EG2 by script 1.

When the bit device that indicates production 
completion turns on, the value of W200 (523)
 is transferred to EG3 using script 2.

D100      OFF→ON
D101      OFF→ON

GB128   OFF→ON
GB129   OFF→ON

EG.b0     OFF→ON
EG.b1     OFF→ON
EG2        233
EG3        523

GOT 1 internal device

EG0.b0/EG1.b1 
turns on at write 
completion.

HR200    233
PLC 2 devices

Bit device indicating completion 
of production OFF→ON

W200      523
PLC 3 devices

Bit device indicating completion 
of production OFF→ON

EG device PLC CPU device Device type Points

EG0 GB128 Bit 32

EG2 D100 Word 2

Item Description

Device D100 to D101

Network setting Host station

Item Description

Device GB128 to GB129

Network setting Host station

N/W No. Station No. IP address

1 2 192.168.0.19
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(b) Script

(3) Setting example of GOT3
(a) Settings for [Gateway Client]

(b) Script

10.13.9 Using the server/client function efficiently

This section explains how to use the server/client function efficiently.

■1 Script setting
If a program using gateway devices directly is executed, the number of times of the access to other stations' GOTs 
increases and the processing delays.
Execute batch read to the GOT internal devices and execute batch write after processing as shown below to decrease 
the number of accesses.
Doing so improves the processing speed.

(1) When executing batch read to store in the GOT internal device (GD) and executing batch write after 
processing
Access to the other station's GOT occurs twice (1) and 3)).
Hence, if one access requires 50 ms, about 100 ms is necessary in total.
The gateway devices are accessed in a batch when the execution condition of the script is satisfied. Therefore, the values 
of the gateway devices when the conditions are satisfied are processed and written.

Item Description

Script 1

Type Screen script

Trigger type On: Bit device that indicates the production completion

Data type Unsigned BIN 16

Example of script description [1-1:w:EG2]=[w:HR200]; //Writes the production count to PLC 1.
set([1-1:b:EG0.00]); //Turns ON the write completion signal.

N/W No. Station No. IP address

1 3 192.168.0.20

Item Description

Script 1

Type Screen script

Trigger type On: Bit device that indicates the production completion

Data type Unsigned BIN 16

Example of script description [1-1:w:EG3]=[w:W200]; // Writes the production count to PLC 1.
set([1-1:b:EG0.01]); //Turns ON the write completion signal.

Ethernet

PLC 1

Client

1)

3)

2) Processing

GD100 to GD109
Server

PLC 3

EG0 to EG9

    Example of a script 
1)  bmov([1-2:w:EG0],[w:GD100],10);
     [w:D200]=[w:GD100];
     [w:D201]=[w:GD101];
     [w:D202]=[w:GD102];
     [w:D203]=[w:GD103];
2)  [w:D204]=[w:GD104];
     [w:GD105]=128;
     [w:GD106]=[w:D106];
     [w:D205]=[w:GD107];
     [w:D206]=[w:GD108];
     [w:GD109]=5433;
3)  bmov([w:GD100],[1-2:w:EG0],10);
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(2) When using gateway devices directly
Access to the other station's GOT occurs 10 times (1) to 10)).
Hence, if one access requires 50 ms, about 500 ms is necessary in total.
The gateway devices are accessed sequentially when the execution condition of the script is satisfied. Therefore, values 
of the gateway devices that differ from themselves when the conditions are satisfied may be written.

■2 Gateway device setting
When assigning the devices of PLCs to gateway devices, assign the same type of devices of the same PLC together as 
far as possible.
Set the same type of devices of the same PLC together as shown below to decrease the number of accesses. Doing so 
improves the processing speed.

➟(2) When the devices of the host station, other stations, and other PLCs are set together

(1) When the devices for the host station, other stations, and other PLCs are not set together
When the GOT (client) accesses the host devices of the GOT (server), program 1), which reads 40 points from EG0 and 
program 2), which reads 10 points from EG130, are necessary.

(2) When the devices of the host station, other stations, and other PLCs are set together
When the GOT (client) accesses the host devices of the GOT (server), only program 1), which reads 50 points from EG0, 
is necessary.

• For more efficiency
If the devices of the same PLC, used for the server/client function, are reserved as a set, as shown below, in the 
system design phase, the GOT (server) needs a smaller number of times of access and thus the processing speed 
improves.

Ethernet

PLC 1

Client

1) 2) 3) ･･････ 8) 9) 10)

D106
D200 to D206

Server

PLC 3

EG0 to EG9

      Example of a script 
1)   [w:D200]=[1-2:w:EG0];
2)   [w:D201]=[1-2:w:EG1];
3)   [w:D202]=[1-2:w:EG2];
4)   [w:D203]=[1-2:w:EG3];
5)   [w:D204]=[1-2:w:EG4];
6)   [1-2:w:EG5]=128;
7)   [1-2:w:EG6]=[w:D106];
8)   [w:D205]=[1-2:w:EG7];
9)   [w:D206]=[1-2:w:EG8];
10) [1-2:w:EG9]=5433;

      Example of a script 
1)   bmov([W:GD100],[1-2:w:EG0],40);
2)   bmov([w:GD140],[1-2:w:EG130],10);

      Example of a script 
1)   bmov([W:GD100],[1-2:w:EG0],50);

If the devices of the same PLC are reserved as a set If the devices of the same PLC are reserved separately

If 100 points of devices are accessed, 
PLC is accessed just 1 time.

If 100 points of devices are accessed, 
PLC is accessed 5 times.
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■3 Performance of the server/client function (reference value)
The following shows the performance (reference values) of the server/client function when [Script Setting] and [Gateway 
Device Setting] are set as shown above.
The reference values are obtained under the conditions shown below.
• The system is configured with one GOT (server) and one GOT (client).
• GOT (server): Numerical input (64 points) setting
• GOT (client): Numerical input (64 points) setting
• Number of assigned device points: 10 word devices

In a system where multiple GOTs (client) are configured, the number of the GOTs (client) multiplied by the response 
speed is the total response speed shown in the above table.

10.13.10 Precautions

The following shows the precautions for using the server/client function.

■1 Precautions for system configuration
(1) Connection to the intranet

If the system needs keeping secure against unauthorized access to the intranet, consult a network service provider or a 
network administrator (a person who does network planning, IP address management, and others), and include your own 
countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the intranet connection.

(2) Countermeasures against access delay
When multiple network devices (including GOTs) are connected to the same segment, the network load increases and 
therefore the communication performance between the GOT and PLC may be degraded.
The following countermeasures may improve the communication performance.
• Using the switching hub
• Reducing the number of devices the GOT monitors

(3) When a firewall is used
If a firewall disconnects the communication of the gateway function, take countermeasures such as changing the port No. 
to be protected behind the firewall.
If the system needs keeping secure against unauthorized access in changing the port No. to be protected behind the 
firewall, consult the network administrator (a person who does network planning, IP address management, and others), 
and develop your own countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the change of the port No.

Combinations for improving the efficiency Response speed when 
direct CPU connection 

(serial) is usedImproving the efficiency of the script Improving the gateway device setting efficiency

○
➟(1) When executing batch read to store in the GOT internal 

device (GD) and executing batch write after processing

○
➟(2) When the devices of the host station, other 

stations, and other PLCs are set together
About 260 ms

○
➟(1) When executing batch read to store in the GOT internal 

device (GD) and executing batch write after processing

× 
➟(1) When the devices for the host station, other 

stations, and other PLCs are not set together

About 1300 ms
×
➟(2) When using gateway devices directly

○
➟(2) When the devices of the host station, other 

stations, and other PLCs are set together

×
➟(2) When using gateway devices directly

×
➟(1) When the devices for the host station, other 

stations, and other PLCs are not set together

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Precautions for station No. switching
When you monitor gateway devices, which have been assigned to controller devices, the monitored devices are not 
switched at station No. switching.
Create the screen for each station.

Step 1 Execute the station No. switching.
Step 2 The numerical display on the GOT (server) is changed by the station No. switching.
Step 3 The station No. switching does not affect the assignment of the gateway devices. Therefore, read the value 

of EG0 of the PLC (station number 0) to GD100 with the script.
Step 4 The numerical display of the GOT (client) is not affected by the station No. switching.

■3 Precautions on the script setting
(1) Setting the trigger type

When setting the script, do not set the trigger type to [Ordinary] or [Sampling, 2 sec.].
The setting may affect other monitoring operations.

(2) Monitoring gateway devices with a script
A script cannot be used to monitor the gateway devices of the GOT itself (GOT) where the script is executed.
To monitor the PLC devices assigned to the gateway devices, monitor the PLC devices directly.

(3) Specifying the network No. and PLC station number in a script
In the script, which accesses the gateway devices of the target GOT, specify the network No. and the PLC station number 
of the target GOT.
Even if 0-FF (host station) is set for the target, the gateway devices cannot be monitored.

(4) When using the bmov instruction in a script
A script does not run properly in the following cases.
• A bit device that cannot be specified as a word device is assigned to a gateway device. This gateway device is specified 
for a command specifying word devices.

• A word device that cannot be specified as a bit device is assigned to a gateway device. This gateway device is specified 
for a command specifying bit devices.

Do not specify such gateway devices for the commands specifying word devices and bit devices.
The following shows the commands specifying word devices and bit devices.

Server

Ethernet

Station No.0 
(00FF)

1.2.

3.

Client

4.

Numerical 
display 
GD100 =  250
(D100)

Numerical 
display 
GD100 =  250
(D100)

Station No.1 
(0101)

Station No.2

Station No.3

Station No.1 is monitored.

D100: 200

D100: 250

D100: 200

D100: 150

Station No. 
switching is
executed.

Numerical 
display
GD100 =  200
(D100)

With the script function, 
GD100 reads the value 
of EG0. 
bmov([1-1:w:EG0],
[w:GD100],1);

Station No. switching 
device 
D50  00FF → 0101

Server setting 
• Assignment 
  definition 
  EG0=D100

Item Command type Content

Commands specifying word 
devices

Function (application 
arithmetic operation) sin, cos, tan, asin, acos, atan, abs, log, log10, exp, ldexp, sqrt

Commands specifying bit devices

Operator (bit device) &, |, ~, ^, <<, >>

Operator (assignment) =

Function (device operation) set, rst alt
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For the details of each device, refer to the following.
➟12.4 Device Range and Settings of Each Controller

For the details of each command, refer to the following.
➟9.9.2 ■3 Control structures for a project script, screen script, and script part
　 9.10.2 ■2 Control structure of object scripts

(5) Number of devices used for the bmov and fmov functions
If the gateway devices are used for the bmov and fmov functions, up to 400 devices are usable.

■4 Precautions for monitoring
• If you try to monitor the gateway devices of the GOT (server) in the situation that the server or client function cannot be 
used due to the power off of either of the GOTs or other possible causes, the error (error code 16) at the execution of the 
script occurs at the GOT (client) and the script stops
For the errors for the execution of a script, refer to the following.

➟9.9.14 Troubleshooting
• When a gateway device to which no PLC device is assigned is monitored, it is monitored as 0 (off if a bit device is 
specified).
When a write operation on values is executed, the values are invalid.

• During the execution of a script that uses gateway devices, the screen save time may be affected.
Canceling the screen saver (by a screen touch or human sensor) may take longer time than usual.
(When the script processing takes 2 seconds, for example, it takes a maximum of 2 seconds for the screen saver to be 
canceled after the screen is touched.)
When the automatic screen saver is set, the execution intervals may be longer than the specified interval.

■5 Precautions for assigning devices
The gateway devices are set in a set of two points.
Therefore, the number of assigned devices depends on the controller devices to be set.

(1) When assigning bit devices to gateway devices
Bit devices are assigned in a unit of 32 points.

(2) When assigning word devices to gateway devices
Word devices are assigned in a unit of 2 points.

(3) When assigning double-word devices to gateway devices
Double-word devices are assigned in a unit of 1 point.

(4) When assigning 8-bit devices to gateway devices
8-bit devices are assigned in a unit of 4 points.

EG0M0  to   M15
EG1M16 to   M31

M15 to   M0
M31 to   M16

15      to      0 bit (s) 15      to      0 bit (s)

EG0
15 to 0 bit (s)

EG1

15 to 0 bit (s)
D0
D1

D0
D1

EG0CN200
EG1

31       to       16 15      to      0 bit (s) 15        to        0 bit (s)
CN200.b15 to b0
CN200.b31 to b16

EG0

EG1

E0000E0001

E0002E0003

E0000

E0001

E0002

E0003

7  to  0 bit (s) 15      to      0 bit (s)
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10.13.11 Relevant settings

Set the relevant settings other than the specific settings for the server/client function as required. The following shows the 
functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifies the operation availability status of the server function. GS200.b3

Notifies the operation availability status of the client function. GS200.b4

Turns on when an error occurs in the use of the server function. GS200.b14

Turns on when an error occurs in the use of the client function. GS200.b15

Stores the number of errors that occur in the use of the server function. GS210

Stores the error codes of errors that occur in the use of the server function. GS211

Stores the year (upper byte, two lower digits of year) and the month (lower byte) with BCD code when an error 
occurs in the use of the server function. GS212

Stores the year (upper byte) and the hour (lower byte) with BCD code when an error occurs in the use of the server 
function. GS213

Stores the minute (upper byte) and the second (lower byte) with BCD code when an error occurs in the use of the 
server function. GS214

Stores the lower part of the IP address of the GOT (client), where an error occurs in the use of the server function, 
with BCD code. GS215

Stores the upper part of the IP address of the GOT (client), where an error occurs in the use of the server function, 
with BCD code. GS216

Stores the number of errors that occur in the use of the client function. GS220

Stores the error codes of errors that occur in the use of the client function. GS221

Stores the year (upper byte, two lower digits of year) and the month (lower byte) with BCD code when an error 
occurs in the use of the client function. GS222

Stores the day (upper byte, two lower digits of year) and the hour (lower byte) with BCD code when an error occurs 
in use of the client function. GS223

Stores the minute (upper byte) and the second (lower byte) with BCD code when an error occurs in the use of the 
client function. GS224

Stores the lower part of the IP address of the GOT (server), where an error occurs in the use of the client function, 
with BCD code. GS225

Stores the upper part of the IP address of the GOT (server), where an error occurs in the use of the client function, 
with BCD code. GS226

Clears the errors (GS200.b14, GS210 to GS216) of the server function. GS400.b14

Clears the errors (GS200.b15, GS220 to GS226) of the client function. GS400.b15
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10.13.12 Troubleshooting

■1 Troubleshooting for the server/client function
The following shows the troubleshooting for the server/client function.

*1 For the details of the Gateway Common Information (GS200), refer to the following.

➟12.1.3 GOT special register (GS)
*2 To check if the GOT responds to Ping, give the ping command through the personal computer to the GOT.

■2 Error information of the server/client function
The error information of the server/client function is stored in the GOT special register (GS).
Check the error information of the server/client function by monitoring the following GOT special registers.
For the details of the GOT special register, refer to the following.

➟12.1.3 GOT special register (GS)
• Write device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

The server/client 
function does 
not work.

When all the bits of GS200 
are off and the GOT does 
not respond to Ping *1*2

The system application (extended function) for the 
server/client function is not installed on the GOT.

Write the package data, which contains the 
system application (extended function) for the 
server/client function, to the GOT.
➟4. COMMUNICATING WITH GOT

No IP address has been set for the GOT. Set the IP address for the GOT in the utility of the 
GOT.

The port number of the personal computer (client) 
is different from that of the GOT (5011).

Set the same port number for the personal 
computer (client) and for the GOT (5011).

If any bit of GS200 is on 
and the GOT responds to 
Ping *1*2

-
Refer to the troubleshooting for the functions 
corresponding to the bits which are on, and take 
the corrective actions.

A gateway device cannot be monitored.

A device that does not exist in the server settings 
has been monitored.

Check the controller devices that have been 
assigned to the gateway devices.

The IP address of the GOT to be monitored has 
been incorrectly set in the client settings.

Check the IP address of the GOT to be 
monitored.

An error has occurred in either of the GOTs (server 
or client).

Check the GOT special registers GS211 and 
GS221 and take the corrective actions.
➟■3 Error code list of the server/client function

A script function error has occurred.

Check the script function error and take the 
corrective actions.
➟9.8 Controlling Operations with Scripts 

([Script])

Device Function Description

GS210

Server 
function

Error counter Stores the number of errors that have occurred.

GS211 Error code
Stores the error code.
➟■3 Error code list of the server/client function

GS212

Error date and 
time

Stores the year (upper byte, two lower digits of year) and the month (lower byte) of the 
error occurrence date/time in BCD code.

GS213 Stores the day (upper byte) and the hour (lower byte) of the error occurrence date/time 
in BCD code.

GS214 Stores the minute (upper byte) and the second (lower byte) of the error occurrence date/
time in BCD code.

GS215
Request source

Stores the lower part of the IP address of the GOT (client), where an error has occurred, 
with BIN code.

GS216 Stores the upper part of the IP address of the GOT (client), where an error has occurred, 
with BIN code.
10 - 244 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.13 Monitoring a Controller through a GOT (Server/Client Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
■3 Error code list of the server/client function
The following lists the error codes that are stored in the GOT special registers GS211 (Server Function Error Code) and 
GS221 (Client Function Error Code).

*1 The error caused in the GOT (server) is error code 493 only.

(1) Error code 493 has occurred in the GOT (server).
The error may occur in a congested network.
If no error has occurred in the GOT (client), the communication recovers by the retry processing of the GOT (client) .

(2) A system where a router is used
If error code 493 has occurred in the GOT (server), the router address is taken as the IP address of the target client.

(3) An error has occurred in the GOT (client).
When an error occurs in the GOT (client), the script stops its operation.
When an error occurs, execute the script again after taking the corrective actions. For the details of the script, refer to the 
following.

➟9.8 Controlling Operations with Scripts ([Script])

GS220

Client 
function

Error counter Stores the number of errors that have occurred.

GS221 Error code
Stores the error code.
➟■3 Error code list of the server/client function

GS222

Error date and 
time

Stores the year (upper byte, two lower digits of year) and the month (lower byte) of the 
error occurrence date/time in BCD code.

GS223 Stores the day (upper byte) and the hour (lower byte) of the error occurrence date/time 
in BCD code.

GS224 Stores the minute (upper byte) and the second (lower byte) of the error occurrence date/
time in BCD code.

GS225
Request target

Stores the lower part of the IP address of the GOT (server), where an error has occurred, 
with BIN code.

GS226 Stores the upper part of the IP address of the GOT (server), where an error has occurred, 
with BIN code.

Device Function Description

Error code *1 Details of error and cause Corrective action

490 A script was used for monitoring the gate 
device that executed the script.

• Change the monitor destination GOT specified in the script to another GOT.
• Monitor the PLC devices directly without using the script.

491 A station that does not exist was accessed. Check the network number, the PLC station number, and the Ethernet settings of the 
the monitor destination.

492 A communication timeout error has occurred.

• Specify a longer communication timeout period.

➟5.5.1 ■4 [Controller Setting]
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)
• Check for cable disconnection, and check the module mounting status.

493 A communication error has occurred.
• Check for cable disconnection, and check the module mounting status.
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)

Ethernet

IP address of the GOT: 192.168.0.18

IP address of the GOT: 192.168.1.18

Server

Client

IP: 192.168.0.254

IP: 192.168.1.254
Router

What is stored in the GOT 
internal device is not the IP
address of the GOT (client) but 
that of the router (192.168.0.254) 
when the error of error code 493 
occurs.
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(4) Error code 492 has occurred in the GOT (client)
The error may occur when multiple GOTs (client) access the GOT (server).
Adjust the value of [Timeout Time].
Refer to the following calculation to set the value.
Timeout time that is already set × Number of GOTs (client) = [Timeout Time] after the adjustment

(5) Error code 15 (the script has not completed within Script Monitoring Time) was stored to the script 
error data (GS16 to GS47) when a script with gateway devices was used.
The error may occur when multiple GOTs (client) access the GOT (server).
Adjust the value of the [script monitoring time](GS385).
Refer to the following calculation to set the value.
Timeout time that is already set × Number of GOTs (client) = [script monitoring time] after the adjustment
For the details of the script, refer to the following.

➟9.8 Controlling Operations with Scripts ([Script])

■4 Error code list of MX Component
The following lists the error codes of the errors which occur when the GOT is accessed from MX Component.

*1 When an error other than those listed above occurs, refer to the following.

➟MX Component Version 3 Operating Manual
MX Component Version 3 Programming Manual

*2 For details of the GOT error codes, refer to the following.

➟GOT2000 Series User's Manual (Utility)

Error code*1 Details of error and cause Corrective action

0x0180840B
Timeout error
Data could not be received within the 
timeout time.

Corrective action for MX Component
• Review the timeout value in the property.
• Set the timeout value again in the communication setting utility.
• Review the system such as the PLC CPU settings, module settings, and the 

cable status.
• Retry the method.
• Perform Close once and execute Open again.
• Exit the program and restart the IBM-PC/AT compatible.

➟Programming Manual for MX Component
Corrective action for GOT
• Check if the server settings for GT Designer3 are configured.

➟10.13.6 [Gateway Server]

0x010F4030
An unavailable device or device that does 
not exist has been assigned to the 
accessed gateway device.

Check that the device assignment is correct or the set devices exist in the 
server settings of GT Designer3.

0x010F4031
A device of PLCs outside the monitor 
range has been assigned to the accessed 
gateway device.

Check if the devices that are within the monitor range are assigned in the 
server settings of GT Designer3.

0x010F4B00
A communication timeout has occurred.
A module is not mounted correctly or a 
cable is not correctly.

• Check for cable disconnection, and check the communication unit mounting 
status, and the PLC status.

• The communication timeout may occur when the load on the PLC increases 
during the access to another station.
In this case, move the data in another station to the PLC of the host station, 
and monitor the data at the host station.

• If the sequence scan time is long, insert the COM instruction.
• Check the GOT error codes of the system alarm or system information.

When an error has occurred, take the corrective actions.
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10.14 Monitoring a Controller through a GOT Using GENESIS64 (GENESIS 
Interaction Function)

10.14.1 Overview of the GENESIS interaction function

The GENESIS interaction function refers to a function used to collect or change device data of the controller monitored 
by a GOT (server) on the personal computer on which GENESIS64 is installed.
To use the GENESIS interaction function, configure the server function settings in the GOT (server) and establish 
correlation between the tags and the GOT gateway devices in GENESIS64.
The "tags" are data used when GENESIS64 accesses external data.
After establishing correlation between the tags and gateway devices in GENESIS64, assign the tags to the objects of 
GENESIS64. Then, you can read/write data from/to the controller connected to the GOT using the tags correlated with 
the gateway devices.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Access to the gateway devices

Line
A 1254

B 348

A 250

B 348

Label10=EG0
Label20=EG1
Label30=EG2
　　　 ：

Ethernet

Personal computer
(GENESIS64)

GOT
(server)

D100=250
D200=380
D300=170
　　 ：Controller

Tag setting

GENESIS64

EG0=D100
EG1=D200
EG2=D300
　　 ：

Assignment
definition

Settings the tags
to the objects
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Establish correlation between the tags and the GOT gateway devices in GENESIS64 manually or by importing the label 
information of GT Designer3.
To import the label information of GT Designer3, assign the labels to the gateway devices in GT Designer3, and output 
that label definition to a label information file.
Import the outputted label information file as "tags" to GENESIS64, and you can set the tags to the objects on the screen 
design application in GENESIS64.
The label names used in GT Designer3 can be used for the tags, enabling you to design a screen with the names without 
paying attention to the device names.

The following shows the outline of operation required to enable the GENESIS interaction function.

■1 Registering the GOT information
In GENESIS64, the GOT information can be registered manually or by using the function that runs automatically to detect 
the GOTs on the same Ethernet network.

■2 Tag settings
Create tags in GENESIS64 and establish correlation between the tags and the GOT gateway devices.
You can create tags manually or by importing the label information file created in GT Designer3 to GENESIS64.

■3 Setting the tags to the objects of GENESIS64
GENESIS64 sorts the tags by GOT.
In the GENESIS64 screen design application, the sorted tags are displayed in the tree structure. This enables you to set 
the tags to the objects without specifying the connected GOTs one by one.

GENESIS64

GOT1
(server)

GT Designer3

Controller

Line
A 1254

B 348

A 1254

B 348

● Settings the tags to the objects

Label information file

● Setting the labels

●  Settings to enable the server function

Writing a project

● Exporting the label definition to a file

● Tag setting
　・Setting the tags manually
　・Importing the label information file 
                                  as tag information

● Registering GOT information
GOT1
GOT2
　：

GOT1
Label10=EG0
Label20=EG1
Label30=EG2
　　　：

Label definition

Tag
Label10=EG0
Label20=EG1
Label30=EG2
　　　 ：

●  When using the label information as tags

Personal computer
(GENESIS64)
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10.14.2 Specifications of the GENESIS interaction function

10.14.3 GENESIS interaction function setting procedure

To enable the GENESIS interaction, operate GT Designer3 and GENESIS64.

■1 Operation in GT Designer3
Step 1 Open the [Label Group Property] dialog to create label groups for GENESIS64.

For details on the label group operation, refer to the following.
➟6.1.5 ■2 Registering, editing, and deleting the label (GT Designer3)

Step 2 In the [Label Group] dialog of a created label group, enter the tag names to be used in GENESIS64 to [Label 
Name] and the GOT gateway devices to be assigned to the tags to [Assign (Device)].

Step 3 Click the [Export] button to output the setting details to a label information file.
Output the file in either of the following conditions.

• Unicode text file
• CSV file with the display language of GT Designer3 set to English

Step 4 Configure the settings to use the server function.

➟10.13.4 ■2 Setting procedure
Step 5 Write the package data to the GOT.

➟4. COMMUNICATING WITH GOT

■2 Operation in GENESIS64
For how to operate GENESIS64, refer to the manual of GENESIS64.

Step 1 Register the GOT information in the Workbench.
Step 2 Import the label information files created in GT Designer3 for the registered GOTs.

Step 3 Activate the connected GOTs (servers) to be used.

Step 4 Assign the tags to the objects when creating a screen in an application such as GraphWorX64.

Item Description

Applicable GENESIS64 Version10.97.1 or later

Applicable GOT

• GT27
• GT25
• GT SoftGOT2000 Version1.265B or later
• GS25

Applicable GT Designer3 Version1.265B or later

Range of devices accessible by GENESIS64 ➟10.13.2 ■5 Access range that can be monitored
• GT SoftGOT2000 on the personal computer (GENESIS64) be used as a server.

Number of GOTs (servers) simultaneously 
accessible to the personal computer 
(GENESIS64)

16 maximum

Number of automatically detected GOTs 255 maximum (the total of GOTs and GT SoftGOT2000 modules)
For GT SoftGOT2000, the number of running modules is the maximum number of automatically 
detected modules.

Devices that can be monitored in 
GENESIS64

Refer to the following.
➟12.3 Device Range and Settings of Mitsubishi Electric Equipment
12.4 Device Range and Settings of Each Controller

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Software Operation

GT Designer3
• Assigning the labels to the gateway devices
• Exporting the information to label information files

GENESIS64

• Registering the GOT information
• Importing the label information files
• Activating the GOTs to be used
• Assigning the tags to the objects
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10.15 Sending a Mail from the GOT (Mail Send Function)

The specifications of the mail send function differ between the GOT and GT SoftGOT2000.
For the mail send function of GT SoftGOT2000, refer to the following.

➟GT SoftGOT2000 Version1 Operating Manual

10.15.1 Overview of the mail send function

When an error occurs or is reset, you can send the information to personal computers and smartphones by an e-mail 
using an alarm display object.
For the details of the alarm display, refer to the following.

➟9.1.5 Viewing alarm events (Alarm display)

Step 1 The GOT uses the alarm display to issue an e-mail sending request to the SMTP server.
Step 2 The SMTP server sends an e-mail in response to the request from the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet

RS-232 
communication

RS-422 
communication

RS-422 
communication

Company A PLC Microcomputer boardMITSUBISHI PLC

1.

2.

Mail send
function

Mail send
function

Mail send
function

SMTP (mail) 
server

Internet

• Alarm display 
  Alarm information or recovery information are sent.

Smartphone
10 - 250 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.15 Sending a Mail from the GOT (Mail Send Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
10.15.2 Specifications of the mail send function

■1 System application (extended function)
To use the mail send function, a system application (extended function) of [Gateway(Mail)] is required.
Selecting [Use the function of Mail] and configuring the settings in [Mail] in the [Controller Setting] window incorporate the 
application into the package data automatically.

➟10.13.5 [Communication Setting]
10.15.4 [Mail]

■2 Required version of CoreOS
CoreOS version AC or later is required to specify a mail server with the host name.
If the CoreOS version is earlier than AC, system alarm 698 is output at GOT startup and e-mails cannot be sent.
Even though the DNS server settings are configured, if the SMTP server and POP3 server are both specified with the IP 
address, system alarm 698 is output. 
In this case, e-mails can be sent.

■3 Number of mail send function settings for one project
One mail send function setting is available for one project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Specifications of mail sending
The following shows the specifications of the mail send function.

The following shows mail software whose operations have been validated by Mitsubishi Electric Corporation.
The GOT (mail sender) does not require the mail software.

■5 Applicable languages for mail sending
Only Japanese and English are applicable.
For the other languages, the mail is sent as [?].

■6 Clock setting of the GOT
Depending on the clock setting (time setting and time notification) of the GOT, a problem may occur, such as the clock data 
set in the GOT or the controller is not reflected.
For the clock setting of the GOT, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])

■7 Date/Time of mail sending
The date and time of the SMTP server at mail sending is attached to the mail.

Item Specifications

Mail sender address FROM 1 (Max. 64 characters: one-byte alphanumeric characters and symbols only)

Mail receiver address

TO 1 to 32 (Max. 64 characters per address: one-byte alphanumeric characters and symbols only)

CC
0 to 32 (Max. 64 characters per address: one-byte alphanumeric characters and symbols only)

BCC

Subject SUBJECT Max. 128 characters (One-byte alphanumeric characters and symbols only)

SMTP server

Port
0 to 65535
Do not use a port for encrypted communications (SSL, TLS, or STARTTLS).
Such a port cannot be used for the mail send function.

Address

Specify the IP address or host name (when using a DNS server).
IP address: 0.0.0.0 to 255.255.255.255
Host name: Max. 253 characters (One-byte alphanumeric characters and symbols only)
If the internet service provider allows direct specification of the IP address to access the server, e-mails 
can be sent via a router.

Authentication 
method

Specify SMTP authentication (CRAM-MD5, LOGIN, PLAIN) or POP before SMTP.
Set the user name and password for SMTP authentication.
Set the user name, password, and POP3 server address for POP before SMTP.
• User name: Max. 256 characters (one-byte alphanumeric characters and symbols only)
• Password: Max. 256 characters (one-byte alphanumeric characters and symbols only)
To use a password of 129 or more characters, install version AA or later of BootOS on the GOT.
For information on how to install the BootOS, refer to the following.

➟4.3.2 ■1 Writing data to one GOT
• POP3 server: Specify the IP address or host name (when using a DNS server).
IP address: 0.0.0.0 to 255.255.255.255
Host name: Max. 253 characters (One-byte alphanumeric characters and symbols only)
For a POP server, use one having port 110 that does not provide encrypted communications (SSL, 
TLS, or STARTTLS).

Number of characters

The following two types of comments can be sent.
• Comment displayed as an alarm message

: Max. 1024 characters (Alphanumeric characters)
• Comment displayed in the comment window of the alarm detail display

: Max. 1024 characters (Alphanumeric characters)

Max. number of 
sending mails

Max. 16 mails can be sent at a time.
If 17 or more mails are attempted to be sent, 16 of them are sent.

Name Manufacturer

Outlook2010, Outlook2007, Outlook2003, OutlookExpress6 Microsoft Corporation

AL-Mail32 Version1.13 (shareware) -

Winbiff Orangesoft Inc.
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10.15.3 How to use the mail send function

■1 System configuration
For the communication interface settings, refer to the following.

➟10.13.5 [Communication Setting]

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)
• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Not available to GT2505-V and GT25HS-V.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

SMTP (mail) server Connection cable*1*2, Wireless access point
Maximum 
segment 
length*3

GOT

Option GOT model

Personal computer 
or others

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable (UTP): 
Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

100m

- (Built into GOT)
GT27
GT25
GS25

GT25-J71E71-100
GT27

GT25 *6

- - GT25-WLAN
GT27 *4

GT25 *4*6

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN access points and system devices, 
refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE 
Series (for Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *5

GT25 *5*6

GS25 *5

Available cables 
differ depending 

on the connection type.
GOT PLC

SMTP (mail) server 
(personal computer, etc.)

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
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■2 Setting procedure
Step 1 Consider the configuration of the whole system.

• Configuration of the whole system including controllers and GOTs
• Controller settings (including device assignment)
• GOT settings (including IP address, network number, and station number)

Step 2 Connect the GOT and the controllers.

➟■1 System configuration
Step 3 Configure the communication interface settings.

➟10.13.5 [Communication Setting]
Step 4 Configure the mail settings with GT Designer3.

➟10.15.4 [Mail]
Step 5 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 6 Check the GOT operation.

➟10.15.5 Procedure of the mail send function
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10.15.4 [Mail]

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [Mail] in the [Controller Setting] window and set the required items.

1) [Use the function of Mail]
Select this item to use the mail send function.

2) [FROM]
Set the address of the mail sender.
One address can be set.
Up to 64 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃
Set one of the following addresses since the GOT does not have its own address.
• Address set to [TO]
• Address you want to use as the return address

3) [TO]
Set the address of the mail receiver.
When setting addresses of multiple mail receivers, separate the addresses by commas or spaces.
Up to 32 addresses can be set.
Up to 64 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃

4) [CC]
Set the address of the mail receiver. (carbon copy). (You can send mails without [CC].)
Up to 32 addresses can be set.
Up to 64 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃

5) [BCC]
Set the address of the mail receiver. (blind carbon copy). (You can send mails without [BCC].)
Up to 32 addresses can be set.
Up to 64 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃

6) [SUBJECT]
Set the title of the mail.
When receiving e-mails from multiple GOTs, set a different subject for each GOT to identify the sender.
Up to 128 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
4)
5)
6)

9)

10)
11)
12)

7)

8)

13)
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7) [Use DNS Server]
Select this item to specify the SMTP server and POP3 server with the host name and set the following items.
To check the IP addresses of the DNS servers, contact the network administrator or connection provider (visiting its 
website, for example).
• [Preferred Server]:

Specify a server to communicate with first as a DNS server.
The setting range is [0.0.0.0] to [255.255.255.255].

• [Alternate Server]:
Specify a server to communicate with if attempting to communicate with the preferred server fails.
The setting range is [0.0.0.0] to [255.255.255.255].

8) [SMTP Port]
Set the port number of an SMTP server.
The setting range is [0] to [65535].

9) [SMTP Server]
Set the address of an SMTP server.
• [IP Address]:

Specify the IP address.
Specification with the IP address is available even when [Use DNS server] is selected.
The setting range is [0.0.0.0] to [255.255.255.255].

• [Host Name]:
This item is enabled when [Use DNS server] is selected.
Specify the host name.
Set the full computer name (the computer name + . (period) + domain name) for the host name.
Up to 253 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
- .
When using e-mail service, set the specified SMTP server.
The e-mail service providers whose operations are validated by Mitsubishi Electric Corporation are as follows (as of 
November, 2021).
- Asahi Net (****@asahi-net.or.jp): mail.asahi-net.or.jp
- au one net (****@**.auone-net.jp): msa.**.auone-net.jp (** parts depend on the e-mail addresses.)
- Twilio SendGrid: smtp.sendgrid.net

10) [This server requires authentication]
Uses the server authentication.
Select this item, and set the relevant items for server authentication.

• [SMTP Authentication]
Uses SMTP authentication.
Select this item, and set [User Name] and [Password].

• [POP before SMTP]
Uses POP before SMTP.
Select this item, and set [User Name], [Password], and [POP3 Server].

11) [User Name]
Set the user name for server authentication.
Up to 256 one-byte alphanumeric characters (uppercase or lowercase), one-byte spaces, and symbols below are 
usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃

12) [Password]
Set the password for server authentication.
Up to 256 one-byte alphanumeric characters (uppercase or lowercase), one-byte spaces, and symbols below are 
usable.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | }  ̃
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13) [POP3 Server]
Set this item when the authentication method is set to [POP before SMTP].
Set the address of a POP3 server.

• [IP Address]:
Specify the IP address.
Specification with the IP address is available even when [Use DNS server] is selected.
The setting range is [0.0.0.0] to [255.255.255.255].

• [Host Name]:
This item is enabled when [Use DNS server] is selected.
Specify the host name.
Up to 253 one-byte alphanumeric characters (uppercase or lowercase) and symbols below are usable.
- .
When using e-mail service, set the specified POP3 server.
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10.15.5 Procedure of the mail send function

■1 Application examples
The following shows an application example of the mail send function.

(1) Sending mails to notify the production site and office of the details of an alarm occurring in the GOT

*1 GOTs cannot receive mails. Thus, set the mail address of the personal computer at the production site for FROM.
If the mail address of the personal computer at the production site is set for FROM, the office (administrator) can send back a 
mail to the production site to obtain the information about the latest recovery status.

Step 1 If an alarm occurs, the GOT sends an e-mail to notify the alarm to personal computer 1 (production site 
(operator)), smartphones, and personal computer 2 (office (administrator)).

Step 2 The production site receives the mail to notify the alarm, and then repairs and recovers the system.
Step 3 The office sends a mail to request a report about the latest recovery status to the production site.

The following shows the setting example of the GOT.
Set the comments displayed in the alarm display in advance.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Controller setting

GOT IP address 10.97.14.1

Send delay time 0 (ms)

Communication timeout 
time 3 seconds

Startup time 3 seconds

Mail setting

SMTP 10.97.14.12

FROM Mail address of personal computer 1 (production site (operator))

TO Mail address of personal computer 1 (production site (operator))

CC Mail addresses of personal computer 2 (office (administrator)) and smartphones

SUBJECT Module VI - Line A

Alarm display
(Alarm display screen)

Device Controller device to be monitored

Mail sending When the error occurs and recovery is completed

Ethernet

Personal computer 1 
(Production site (operator))

PLC

Personal computer 2 
(Office (administrator))

Sending 
a mail

Sending a mail

Sending a mail

SMTP (mail) server 
(10.97.14.12)

Internet

Internet

GOT
(10.97.14.1)

Sending a mail

1.

3.

2. Sending back a mail *1 
Checking with operator 
about the recovery status

Smartphone
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■2 Sending example
When a target device receives a mail from the GOT, the header of the received mail has a line showing that the GOT has 
sent the mail as shown below.
The display format and details of the received mail differ depending on the specifications of the mail software installed in 
the target device.
When a smartphone receives an e-mail from the GOT, the display details of the received e-mail may differ depending on 
the specifications (screen size) of the smartphone.
If 17 or more alarms occur or are recovered simultaneously, the details of first 16 alarms are sent.
Display example of the header of the received mail

(1) When sending a mail using the alarm display
If the alarm occurs, the GOT sends mails to notify the receivers of the details on alarm occurrence.
If the alarm is recovered, the GOT sends mails to notify the receivers of the details on alarm recovery.
For how to set the alarm display, refer to the following.

➟9.1.5 Viewing alarm events (Alarm display)

(a) Display example of mail at the receiver

From: **********************
To: ************************
Cc: ************************
Subject:Module VI - Line A
                      :
X-Mailer:GOT

1)

2)

1)

2)

1) A basic alarm comment is displayed.
2) The contents of the detail display ([Details]) set for the alarm display are displayed. 
    If [Not Display], [Base Screen], or [Window Screen] is set for [Detailes] of the alarm display, 
    [Detailes] is not displayed.

[Alarm notice]
[Date/Time of occurrence]
2012/9/14 9:48:15
[Alarm information]
Equipment A feed conveyor stopped 
[Details]
Equipment A feed conveyor has been stopped.
Check the power supply. 

(At alarm occurrence) (At alarm recovery)

[Recovery notice]
[Date/Time of recovery]
2012/9/14 10:38:23
[Recovery information]
Equipment A feed conveyor stopped
[Details]
Equipment A feed conveyor has been stopped.
Check the power supply. 
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10.15.6 Precautions

■1 Precautions for system configuration
(1) Connection to the intranet

If the system needs keeping secure against unauthorized access to the intranet, consult a network service provider or a 
network administrator (a person who does network planning, IP address management, and others), and include your own 
countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the intranet connection.

(2) Countermeasures against access delay
When multiple network devices (including GOTs) are connected to the same segment, the network load increases and 
therefore the communication performance between the GOT and PLC may be degraded.
The following countermeasures may improve the communication performance.
• Using the switching hub
• Reducing the number of devices the GOT monitors

(3) When a firewall is used
If a firewall disconnects the communication of the gateway function, take countermeasures such as changing the port No. 
to be protected behind the firewall.
If the system needs keeping secure against unauthorized access in changing the port No. to be protected behind the 
firewall, consult the network administrator (a person who does network planning, IP address management, and others), 
and develop your own countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the change of the port No.

■2 Precautions for using the mail send function
(1) Sending a mail to one mail address from multiple GOTs

To identify the sender of each mail in the multiple GOTs, set an individual SUBJECT for each mail.
Setting the same SUBJECT for each mail from multiple GOTs causes the difficulty in identifying the sender.

10.15.7 Relevant settings

Set the relevant settings other than the specific settings for the mail send function as required. The following shows the 
functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Holding the on status while the mail send function can be used. GS200.b0

Turning on when the error has occurred in the mail send function. GS200.b11

Storing the number of the errors that have occurred in the mail send function. GS201

Storing the codes of the errors that have occurred in the mail send function. GS202

Storing the year (upper byte, two lower digits of year) and the month (lower byte) of the error occurrence date/time 
when the error has occurred in the mail send function in BCD code. GS203

Storing the day (upper byte) and the hour (lower byte) of the error occurrence date/time when the error has occurred 
in the mail send function in BCD code. GS204

Storing the minute (upper byte) and the second (lower byte) of the error occurrence date/time when the error has 
occurred in the mail send function in BCD code. GS205

Notifying the type of the function that has caused the error in the mail sending process of the mail send function. GS206

Clearing the errors (GS200.b11, GS201 to GS206) of the mail send function. GS400.b11
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10.15.8 Troubleshooting

■1 Troubleshooting for the mail send function
The following shows the troubleshooting for the mail send function.

*1 For the details of the Gateway Common Information (GS200), refer to the following.

➟12.1.3 GOT special register (GS)
*2 To check if the GOT responds to Ping, give the ping command through the personal computer to the GOT.

■2 Error information of the mail send function
The error information of the mail send function is stored in the GOT special register (GS).
Monitor the following GOT special registers to check the error information of the mail send function.
For the details of the GOT special register, refer to the following.

➟12.1.3 GOT special register (GS)

(1) Write device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

The mail send 
function does 
not work.

When all the bits of GS200 
are off and the GOT does 
not respond to Ping *1*2

The system application (extended function) for the 
mail send function is not installed on the GOT.

Write the package data, which contains the 
system application (extended function) for the 
mail send function, to the GOT.
➟4. COMMUNICATING WITH GOT

No IP address has been set for the GOT. Set the IP address for the GOT in the utility of the 
GOT.

The port number of the personal computer (MX 
Component) is different from that of the GOT 
(5011).

Set the same port number for the personal 
computer (MX Component) as that of the GOT 
(5011).

If any bit of GS200 is on 
and the GOT responds to 
Ping *1*2

-
Refer to the troubleshooting for the functions 
corresponding to the bits which are on, and take 
the corrective actions.

Mail cannot be sent.

The SMTP server is not working properly. Check with the network administrator that the 
SMTP server is working properly.

Mail sender address is not properly set for FROM. Set the proper sender address for FROM

The GOT attempted to send 17 or more mails at a 
time. Send 16 or less mails at a time.

Time when the mail has been sent is not 
correct.

Time of the SMTP server is incorrect. (The GOT 
sends mails referring to the time of the SMTP 
server.)

Set the correct time for the SMTP server.

The whole text of the e-mail is not displayed on 
the smartphone.

The number of characters that the smartphone can 
send (receive) has been exceeded.

Reduce the number of characters in the e-mail 
so that the smartphone can send (receive) the e-
mail.

One-byte katakana is converted to two-byte 
katakana.

One-byte katakana cannot be used in the body of 
the mail. One-byte katakana is sent after converted 
to two-byte katakana.

This symptom is not an error.

Device Function Description

GS201

Mail send 
function

Error counter Stores the number of errors that have occurred.

GS202 Error code
Stores the error code.
➟■3 Error code and error message of the mail send function

GS203

Error date and 
time

Stores the year (upper byte, two lower digits of year) and the month (lower byte) of 
the error occurrence date/time in BCD code.

GS204 Stores the day (upper byte) and the hour (lower byte) of the error occurrence date/
time in BCD code.

GS205 Stores the minute (upper byte) and the second (lower byte) of the error occurrence 
date/time in BCD code.

GS206 Mail sender
Notifies the type of the function that has caused the error in the mail sending process.
• 0: 25% 0: No error
• 1: 25% 1: User Alarm Observation
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■3 Error code and error message of the mail send function
The following lists the error codes that are stored in the GOT special register GS202 (Mail Send Function Error Code).

Error code Details of error and cause Corrective action

2 No sender address is set for FROM.
Set the sender address for FROM.

➟10.15.4 [Mail]

3 The SMTP server is not set.
Set the SMTP server.

➟10.15.4 [Mail]

4 No receiver address is set for TO.
Set the receiver address for TO.

➟10.15.4 [Mail]

5 Mail address is incorrect.
Check that the mail addresses for FROM, TO, CC, and BCC are correct.

➟10.15.4 [Mail]

6 Alarms may occur exceeding the number of 
mails that can be sent.

Check the number of alarms that have occurred. (Up to 16 mails can be sent at 
a time to notify the alarm.)

10 The connection with the SMTP server has 
been failed.

• Check if the SMTP server is functioning normally.
• Check if the IP address or host name of the SMTP server is properly set.
• Contact the network administrator to check the router address and the subnet 

mask, and then setup the GOT.
• When the network is protected by a firewall, contact the network administrator 

to check that the specified port number of the SMTP server is allowed to pass 
through the firewall.

11 A timeout has occurred in the connection with 
the SMTP server.

• Check if the SMTP server is functioning normally.
• Specify a longer communication timeout period.

➟5.5.1 ■4 [Controller Setting]

12 The SMTP server notifies the error.
• Check if the SMTP server is functioning normally.
• Contact the network administrator to check that mails can be sent without the 

authentication including POP3.

13 The SMTP authentication has failed.
• Check that the user name and password for the SMTP authentication are set 

correctly.

➟10.15.4 [Mail]

32 The POP3 server address is not set.
• Set the IP address or host name of the POP3 server.

➟10.15.4 [Mail]

34 The connection to the POP3 server has failed.
• Check that the IP address or host name of the POP3 server is set correctly.

➟10.15.4 [Mail]
• Check that the POP3 server is not down.

37 Authentication of the POP3 server has failed.
• Check that the user name and password for the POP3 server are set correctly.

➟10.15.4 [Mail]

40 A DNS server is not set.
• Set a DNS server.

➟10.15.4 [Mail]

42 The host name of the server cannot be 
resolved.

• Check that the address of the DNS server is set correctly.
• Check that the DNS server is not down.
• Check that the host name of the SMTP server and POP3 server are set 

correctly.
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10.16 Transferring a File between the GOT and Peripheral Device (FTP 
Server Function)

10.16.1 Overview of the FTP server function

The FTP server function enables you to read and write a file from/to an external FTP client using the GOT as the FTP 
server.
For GT21, the following models support this function.

• GT2107-W
• GT2104-R
• GT2104-PMBD
• GT2103-PMBD

■1 Reading resource data in the GOT using a personal computer
Files including resource data saved in the GOT can be read using a personal computer (FTP client).
Use this function to read the resource data from multiple GOTs by Ethernet.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet

GOT 
(FTP server)

GOT 
(FTP server)

GOT 
(FTP server)

Personal computer 
(FTP client)

Obtaining 
alarm files

Obtaining 
hard copy

Updating 
recipes

Obtaining files of various 
data from the GOTs 

(FTP server)

Data 
storage

Data 
storage

Data 
storage
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■2 Sending a file from a personal computer to the GOT
Files including resource data can be written to the GOT (FTP server) using a personal computer (FTP client).
Use this function to change the resource data of multiple GOTs at once by Ethernet.

■3 Connection with Multimedia Interaction Tool
When Multimedia Interaction Tool installed in a personal computer is used, the personal computer receives the video files 
and the alarm log files sent from the GOT using the FTP server function.
Not available to GT21 and GS21.

For details of Multimedia Interaction Tool, refer to the following.
• How to use Multimedia Interaction Tool

➟10.8.5 Multimedia Interaction Tool
• How to connect the multimedia unit

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

Ethernet

GOT 
(FTP server)

GOT 
(FTP server)

GOT 
(FTP server)

Personal computer 
(FTP client)

Sending a recipe file from 
the personal computer 

(FTP client)
Updating 
recipes

Updating 
recipes

Updating 
recipes

Data 
storage

Data 
storage

Data 
storage

Ethernet

Personal computer

Video camera

GOT Multimedia unit

誤動作の恐れあり
通電中着脱しないでください
Do not mount not desmount 
a module while the power is 
supplied.

注意 CAUTION

1.
2.

3.Sending video 
files to the 

personal computer 
by Ethernet

Saving the video files 
temporarily to the 
SD card installed 
in the GOT

Saving captured images 
from the video camera 
in the memory card

Data storage
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10.16.2 Specifications of the FTP server function

■1 System application (extended function)
To use the FTP server function, a system application (extended function) of [Gateway(FTP Server)] is required.
Selecting [Use the function of FTP Server] and configuring the settings in [FTP Server] in the [Controller Setting] window 
incorporate the application into the package data automatically.

➟10.13.5 [Communication Setting]
10.16.4 [FTP Server]

■2 Number of FTP server function settings for one project
One FTP server function setting is available for one project.

■3 Specifications of the FTP server
The following shows the specifications of the FTP server function.

*1 If a correct password and login name are not entered within one minute after the FTP client is connected with the GOT, the 
line is disconnected.

*2 If commands are not input from the FTP client within the time set as the command input monitoring cycle, the GOT disconnects 
the line.

*3 For the details of settable file names, refer to the following.

➟10.16.5 ■2 (2) How to specify files

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications

Setting of the FTP server function The function can be enabled and disabled. (Default: disabled)

User name
Up to 16 one-byte alphanumeric characters (a to z, A to Z, 0 to 9) can be set. (Default: Admin)
(The string "anonymous" is unusable.)

Password

Up to 32 one-byte alphanumeric characters (a to z, A to Z, 0 to 9), one-byte spaces, and symbols below can be 
set.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ̃
A one-byte space cannot be used for the start or end of a password.

Port No.
Control port: 21 (fixed)
File transfer port: Randomly assigned in PORT mode and in PASV mode

Number of 
simultaneously 
connectable clients

GT27
GT25
GT23
GS25

1 to 4
Use GS404 to specify the number of connectable clients.
When GS404 stores 0 or 5 or more, 1 is assumed.

➟12.1.3 GOT special register (GS)

GT21
GS21

1

Command input 
monitoring cycle

Before logging 
in *1

1 minute

After logging in 
*2 1 minute to 60 minutes (Default: 15 minutes)

Required devices for the file access Data storage

Available file size for file reading Unlimited (The maximum size depends on the capacity of the data storage.)

File name *3 One-byte alphanumeric characters only

Access mode
Reference mode: Writing to the data storage is not available.
Write mode: Witing to the data storage is available.

Available FTP client

• FTP client compliant with RFC 959
• FTP client which can be accessed from the Windows command prompt using the FTP command
• FTP client which supports the passive mode
For the FTP clients whose operations are confirmed, refer to the following.

➟(1) FTP clients which have been checked for operation
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(1) FTP clients which have been checked for operation
For the FTP clients whose operations have been validated by Mitsubishi Electric Corporation, refer to the following 
Technical Bulletin.

➟List of Devices Validated to Operate with the GOT2000 Series' FTP Server Function/ File Transfer Function 
(GOT-A-0167)

(2) Data which can be read and written using the FTP server function
Files including resource data can be read and written to the GOT (FTP sever) by Ethernet using a personal computer 
(FTP client).
The following files can be read and written using the FTP server function.
• CSV files
• Unicode text files
• Image data
• Binary format files (*.G2□)

(a) Data that cannot be read from, or written to the GOT
Files with the following extensions cannot be read or written by using the FTP server function.

• .OUT
• .FON
• .INI
• .G2
• .PRF

(b) Sending and receiving binary format files (*.G2□)
Binary format files (*.G2□) can be read to a personal computer by using the Gateway Common Control (GS400.b8).
However, the following files cannot be read.

• *.G2
• *.G2D

For the Gateway Common Control (GS400), refer to the following.
➟10.16.5 ■2 (2) (a) Reading a file specifying the file name
12.1.3 GOT special register (GS)
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■4 File access range
The FTP server function allows the FTP client to access the GOTs on the network where the FTP client is connected. 
(Only one FTP client is allowed to access one GOT.)
When you use the FTP sever function via a relay device such as a router, consult with your network manager.

To simply determine whether a file can be accessed or not, issue a ping command for the GOT.
Examples of the ping commands to be issued (when the Windows command prompt is used)
IP address of the GOT: 192.168.0.18

• When the file can be accessed

• When the file cannot be accessed

Ethernet Ethernet

GOT 
(FTP server)Personal computer (FTP client)

PLC GOT 
(FTP server)

PLC

Router

C:\ping 192.168.0.18
  Pinging 192.168.0.18 with 32 bytes of data:
  Reply from 192.168.0.18: bytes=32 time<1ms TTL=128
  Reply from 192.168.0.18: bytes=32 time<1ms TTL=128
  Reply from 192.168.0.18: bytes=32 time<1ms TTL=128
C:\

C:\ping 192.168.0.18
  pinging 192.168.0.18 with 32 byte of data:
  request timed out.
  request timed out.
  request timed out.
C:\
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10.16.3 How to use the FTP server function

■1 System configuration
For the communication interface settings, refer to the following.

➟10.13.5 [Communication Setting]

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)
• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 For the details of applicable FTP clients, refer to the following.

➟10.16.2 ■3 (1) FTP clients which have been checked for operation
*5 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*7 For GT21, the following models support this function.

• GT2107-W

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

FTP client Connection cable*1*2, Wireless LAN access point Maximum 
segment length*3

GOT (FTP server)

Option GOT model

Personal 
computer or 

others*4

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted 
pair cable (UTP): Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

100m

- (Built into GOT)

GT27
GT25
GT23
GT21 *7

GS25
GS21

GT25-J71E71-100
GT27
GT25 *8

- - GT25-WLAN
GT27 *5

GT25 *5*8

GS25 *5

• Wireless LAN access point
For the connectable wireless LAN access points and 
system devices, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series 
and GOT SIMPLE Series (for Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *6

GT25 *6*8

GS25 *6

FTP client (personal 
computer, etc.)

GOT 
(FTP server)

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
10 - 268 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.16 Transferring a File between the GOT and Peripheral Device (FTP Server Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
• GT2104-R
• GT2104-PMBD
• GT2103-PMBD

*8 Not available to GT2505-V and GT25HS-V.

■2 Setting procedure
Step 1 Consider the configuration of the whole system.

• Configuration of the whole system including controllers and GOTs
• Controller settings (including device assignment)
• GOT settings (including IP address, network number, and station number)

Step 2 Connect the GOT and the controllers.

➟■1 System configuration
Step 3 Configure the communication interface settings.

➟10.13.5 [Communication Setting]
Step 4 Configure the FTP server setting on GT Designer3.

➟10.16.4 [FTP Server]
Step 5 Write the package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 6 Check the operation of the FTP server function on the GOT.

➟10.16.5 Procedures of the FTP server function
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10.16.4 [FTP Server]

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [FTP Server] in the [Controller Setting] window and set the necessary items.

1) [Use the function of FTP Server]
Select this item to use the FTP server function.

2) [Command Input Observation Cycle]
Set the time when the line connection with the GOT will be disconnected if any command is not input from the FTP 
client.
The setting range is [1] to [60].
Usually, use the default setting (15 minutes).

3) [Login Name]
Set a login name for connecting the FTP client with the GOT.
You can set one login name.
Up to 16 one-byte alphanumeric characters (a to z, A to Z, 0 to 9) can be used.
The default login name is Admin.

4) [Password]
Set a password for connecting the FTP client with the GOT.
You can set one password. Up to 32 one-byte alphanumeric characters (a to z, A to Z, 0 to 9) can be used.
Alphanumeric characters (a to z, A to Z, 0 to 9) and the following symbols are available.
! " # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } ~
A one-byte space cannot be used for the start or end of a password.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)
4)
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10.16.5 Procedures of the FTP server function

■1 Application examples
The following shows application examples of the FTP server function.
For these application examples, the Windows command prompt is used for accessing between the GOT and the FTP client.
When using a commercially available FTP client tool, refer to the manual of the FTP client tool used.

(1) Outline procedure
The following shows the outline procedure.
For the detailed operating procedure, refer to each item described as follows.

Step 1 Connect the line between the GOT and the FTP client.

➟(2) Connecting the line between the GOT and the FTP client
Step 2 Read files in the GOT (data storage).

➟(3) Reading the files in the GOT (data storage)
Step 3 Write files to the GOT (data storage).

➟(4) Writing files to the GOT (data storage)
Step 4 Manage the directory in the GOT (data storage).

➟(5) Managing the directory in the GOT (data storage)
Step 5 Disconnect the line between the GOT and the FTP client.

➟(6) Disconnecting the line between the GOT and the FTP client
When writing files to the GOT (data storage) or managing the directory, enable writing to the data storage of the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Connecting the line between the GOT and the FTP client
Step 1 Starting the FTP client

Input [ftp] and press the Enter key.
Step 2 Connecting with the GOT

Input [open] and input the IP address of the GOT after the [open]. Then, press the Enter key.
Step 3 Inputting a login name

Input the login name registered previously in the GOT and press the Enter key.
Step 4 Inputting a password

Input the password registered previously in the GOT and press the Enter key.

(3) Reading the files in the GOT (data storage)
Read the files from the GOT in the following procedure.

Step 1 Notifying of no file conversion
Input [binary] and press the Enter key.

Step 2 Reading files
Input [get] and the file name, and press the Enter key.
Example for file reading

C:\>ftp
ftp>open 192.168.0.18
connected to 192.168.0.18
220 GOT2000 FTP server ready.
user:GOT2000
331 Password required.
Password:****
230 User logged in.
ftp>

C:\>ftp
ftp>open 192.168.0.18
connected to 192.168.0.18
421 Session limit reached, closing control connection
user:GOT2000
connection closed by remote host
ftp>

C:\>ftp
ftp>open 192.168.0.18
connected to 192.168.0.18
220 GOT2000 FTP server ready.
user:GOT2000
331 Password required.
Password:****
530 Not logged in.
ftp>

Login image (When the line is properly connected.)

Login image (When a wrong password is input)

Login image (If another personal computer has been connected to the GOT)

ftp>binary
200 TYPE is now BINARY.
ftp>get SNAP0001.BMP
200 PORT command successful
150 Opening connection.
226 Closing data connection.
ftp: 63 bytes sent in 0.00 seconds 63000.00
K bytes/sec.
ftp>
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(4) Writing files to the GOT (data storage)
Write files to the GOT in the following procedure.

Step 1 Notifying of no file conversion
Input [binary] and press the Enter key.

Step 2 Entering the write mode (if not in the write mode)
Input [quote gtwr] and press the Enter key.

Step 3 Display the file name to check that the same file name is not used in the GOT (data storage).
Input [Is] or [dir] and press the Enter key.

Step 4 If the same file name is used in the GOT, delete the file.
Input [delete] and the file name to be deleted, and press the Enter key.

Step 5 Writing files
Input [put] and the file name to be written, and press the Enter key.
Example for file writing

(5) Managing the directory in the GOT (data storage)
Create a directory and modify it in the following procedure.

Step 1 Displaying the current directory
Input [pwd] and press the Enter key.

Step 2 Entering the write mode (if not in the write mode)
Input [quote gtwr] and press the Enter key.

Step 3 Creating a directory
Input [mkdir] and the directory name to be created, and press the Enter key.

Step 4 Modifying the current directory
Input [cd] and the directory name to be modified, and press the Enter key.
Example for directory management

ftp>binary
200 TYPE is now BINARY.
ftp>quote gtwr
200 command successful.
ftp>ls
200 PORT command successful.
150 Opening connection.
SNAP0001.BMP
SNAP0002.BMP
226 Closing data connection.
ftp>delete SNAP.0001.BMP
250 File deleted Successfully.
ftp>put SNAP0001.BMP
200 PORT command successful
150 Opening connection.
226 Closing data connection.
ftp: 63 bytes sent in 0.00 seconds 63000.00
K bytes/sec.
ftp>

ftp>pwd
257 "A:/snapshot" is current directory.
ftp> quote gtwr
200 command successful.
ftp>mkdir bmpdata
275 MKD command successful.
ftp>cd bmpdata
250 CWD command successful.
ftp>pwd
257 "A:/snapshot/bmpdata" is current directoryftp>cd ..
250 CWD command successful.
ftp>pwd
257 "A:/snapshot" is current directory.
ftp>
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(6) Disconnecting the line between the GOT and the FTP client
Disconnect the line between the GOT and the FTP client in the following procedure.

Step 1 Input [quit] (exit command) and press the Enter key.
Example for a logout (disconnection of the line)

(7) Displaying errors
Errors related to the FTP server function are displayed on the FTP client.
For the error messages to be displayed, refer to the following.

➟10.16.8 ■2 Code and message of the FTP server function
If a non-existent file (snap0010.bmp in this example) is intended to be read

■2 Handling on the FTP client side
(1) Input commands for the FTP client
(a) General commands

The following table shows the general commands available for the Windows command prompt and the FTP client, and their 
compatibility with the FTP server function of the GOT.
The following commands cannot be used depending on the specifications of the FTP client to be used.

○: Available, ×: Unavailable

ftp>quit
221 User logged out. Good-Bye.
C:\>

ftp>get snap0010.bmp
200 PORT command successful.
550 snap0010.bmp:No such file or directory.
ftp>

Command name Function Reference
mode

Write
mode

append Writes files additionally to the GOT. × ○

ascii Changes the file transfer mode to the ascii mode. ○ ○

binary Changes the file transfer mode to the binary mode. ○ ○

bye Exits the FTP client tool. ○ ○

cd Changes the current directory of the GOT. ○ ○

cd Disconnects the line with the GOT. ○ ○

delete Deletes files in the GOT. × ○

dir Reads the file information in the GOT. ○ ○

get Reads files from the GOT. ○ ○

ls Displays file names in the GOT. ○ ○

mdelete Deletes multiple files specified with a wild card. × ○

mdir Reads the file information in the GOT to a specified file. ○ ○

mget Reads multiple files specified with a wild card. ○ ○

mkdir Creates a directory in the GOT. × ○

mls Reads the file name in the GOT to a specified file. ○ ○

mput Writes multiple files specified with a wild card to the GOT. × ○

open Connects the line with the GOT. ○ ○

put Writes files to the GOT. × ○

pwd Displays the current directory of the GOT. ○ ○

rename Changes a file name in the GOT. × ○

rmdir Deletes a directory in the GOT. × ○

quit Disconnects the line with the GOT and exits the FTP client tool. ○ ○

quote Use this command when using the GOT-dedicated commands with the command prompt. 
(Example: quote gtwr) ○ ○
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(b) GOT-dedicated commands
When the FTP client is connected to the GOT, the FTP client is in the [write mode].
Issue a command for changing modes between the reference mode and the write mode.

○: Available, ×: Unavailable

*1 When the GOT-dedicated commands are input with the command prompt, use quote.
To input [gtwr] with the command prompt, input [quote gtwr].

*2 The setting is disabled. (The command does not cause an error.)

(2) How to specify files
The following two methods are provided for specifying files: you can directly specify one file or specify multiple files which 
satisfy the condition.

(a) Reading a file specifying the file name
Specify the file name of the file to be specified and add a period and an extension.

• Drive
Specify drive A, drive B, drive C, drive E, drive F, drive G, or drive V.
For GT23, drive A, drive B, drive C, drive E, drive F, or drive G can be specified.
For GT2107-W, drive A or drive E can be specified.
For GT2105-Q, GT2104-R, GT2104-P, GT2103-P, and GS21, drive A can be specified.

• Number of characters for the folder name and file name
The GOT recognizes the location of the file with the following path.
Set a folder name and file name so that the total number of characters used for the path is 78 or less.
Only the folder name and file name in the path can be set by the user.
(Other part of the path is automatically specified.)

To set a hierarchy to the folder, put / (slash) between folder names. (/ (slash) is counted as one character.)
(Setting example)
Folder name: Project1/abc

• Unavailable character strings
The use of the following character strings is prohibited. (You cannot use them regardless of capitals or small letters.)

user Input a user name and a password for logging in the GOT. ○ ○

Command name *1 Function Reference
mode

Write
mode

gtwr Changes the mode of the FTP server function of the GOT to the write mode. ○ ○*2

gtrd Changes the mode of the FTP server function of the GOT to the reference mode. ○*2 ○

help Displays the general commands of the FTP protocol supported by the FTP server function 
of the GOT. ○ ○

gtds Not available to GT21 and GS21. × ○

Command name Function Reference
mode

Write
mode

Drive: / File name +  .  + Extension
Indicates the file type. 
Divides the file name and the extension. 
Name of the file to be read

A  :  /    

Extension (four characters)(one character)(two characters)
Drive name (one character)

A maximum of 78 characters

/     File name      .G2AFolder name 

Project

abc
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COM1 to COM9, LPT1 to LPT9, AUX, CON, NUL, PRN, CLOCK$
The use of the following folder and file names is prohibited.
Folder name starting with G2
[.] (period) or [/] (slash) is used at the beginning or the end of the folder or file names.
Folder or file named as only [.] (one period) or [..] (two periods)

• Extension
The following file extensions are mainly used for the FTP server function.
csv:
Alarm file (alarm), operation log file (operation log), logging file (logging), and recipe file (recipe)
txt:
Alarm file (alarm), operation log file (operation log), logging file (logging), and recipe file (recipe)
bmp,jpg:
Image data (hard copy)
3GP:
Video file (multimedia)

Reading binary format files
When the GOT special register GS400.b8 (bit location: 8) is turned on, the FTP client can read binary format 
files (*.G2□) directly.
However, the following binary format files cannot be read.
• *.G2
• *.G2D
You can use the binary format file read to GT Designer3 as backup data.
Some files can be converted to other formats using GT Designer3.
For the file conversion using GT Designer3, refer to the following.

➟2.3.2 Opening a project

(b) Specifying files which meet the condition (wild card)
To specify multiple files, [*] and [?] can be used as a wild card.
(Example)
*.jpg: When only JPEG files are specified
Main*.csv: When CSV files whose names start with "Main" are specified
*.b??: When files whose extensions start with b are specified

(3) Checking the connection status
Check the connection status between the GOT and an FTP client with the following GOT special registers (GS).

For the details of the GOT special registers, refer to the following.
➟12.1.3 GOT special register (GS)

The following shows application examples.
• Notifying the connection status when one FTP client is connected
Specify GS200.b2 for a lamp object to notify whether an FTP client is connected.

• Notifying the connection status when multiple FTP clients are connected

Item GOT special register (GS) Description

Checking if one FTP client is 
connected to the GOT GS200.b2

This device turns on when an FTP client is connected to the GOT.
Check if an FTP client is connected to the GOT with this device.

Checking if multiple FTP clients are 
connected to the GOT GS208

This device stores the number of the FTP clients connected to the GOT.
Check that FTP clients are connected to the GOT by checking a change 
of the stored value.

Number of connected FTP clients: 0 Number of connected FTP clients: 1

Bit lamp
Monitored device: GS200.b2
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Specify GS208 for a numerical display object to display the number of connected FTP clients.

• Limiting operations
Specify GS200.b2 as the trigger device for a touch switch or numerical input object, and configure the settings to 
disallow inputs while an FTP client is being connected to the GOT.

(4) Disconnecting the line
The following two methods are provided for disconnecting the line: Automatic disconnection and manual disconnection.
Since the GOT cannot detect the error status of the FTP client, if you cannot shut down the FTP client properly (for 
example, if the personal computer is powered off when the line is connected), the GOT does not disconnect the line 
immediately.
However, the line will be automatically disconnected after a specified time since the command input monitoring cycle is 
set.
• Automatic disconnection
If commands are not input from the FTP client within the time set as the command input monitoring cycle in the FTP 
server setting, the GOT disconnects the line automatically.
The command input monitoring cycle must be set.
For the settings of the command input monitoring cycle, refer to the following.

➟10.16.4 [FTP Server]
• Manual disconnection (The line is forcibly disconnected.)
Use GS400.b2 to forcibly disconnect all the FTP clients.
To disconnect the FTP clients, turn on GS400.b2.
Check that the clients are disconnected, and then make sure to turn off GS400.b2.
For the details of the GOT special register, refer to the following.

➟12.1.3 GOT special register (GS)

Number of connected FTP clients: 0 Number of connected FTP clients: 1

0 1

Number of connected FTP clients: 2

2

Numerical display
Monitored device: GS208

GS200.b2: OFF GS200.b2: ON

Production line
A
B
C

Production 
lineA
B
C

Operation is 
disabled while line 
is connected.

Configure the settings with the touch switch function 
or numerical input function so that input is allowed 
only when the device (GS200.b2) is off.
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10.16.6 Precautions

■1 Precautions for system configuration
(1) Connection to the intranet

If the system needs keeping secure against unauthorized access to the intranet, consult a network service provider or a 
network administrator (a person who does network planning, IP address management, and others), and include your own 
countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the intranet connection.

(2) Countermeasures against access delay
When multiple network devices (including GOTs) are connected to the same segment, the network load increases and 
therefore the communication performance between the GOT and PLC may be degraded.
The following countermeasures may improve the communication performance.
• Using the switching hub
• Reducing the number of devices the GOT monitors

(3) When a firewall is used
If a firewall disconnects the communication of the gateway function, take countermeasures such as changing the port No. 
to be protected behind the firewall.
If the system needs keeping secure against unauthorized access in changing the port No. to be protected behind the 
firewall, consult the network administrator (a person who does network planning, IP address management, and others), 
and develop your own countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the change of the port No.

■2 Precautions for using the FTP server function
(1) Precautions for designing the system including the FTP server function
(a) Recipe file format

To write recipe files from the FTP client to the GOT, set the same format of the recipe files as the one set with the recipe 
of the GOT.
To write recipe files from a personal computer at a distant location, check the procedure with field workers before writing 
recipe files.

(b) Performing a test on the FTP client tool
Before using the FTP client tool, make sure to read the manual for the FTP client tool to check the functions and operating 
procedure, then conduct the test operation.
Some operations may not be supported by the GOT (FTP server) depending on the FTP client tool to be used.
Also, depending on the FTP client tool used, the FTP server function may not be usable because the GOT cannot support 
the extended command (quote) and issue GOT-dedicated commands.

(c) Reading multiple files using one command
If you read many files at once using one command (if you execute mget or mput specifying a wild card), the processing may 
be slowed down due to network congestion.
When the processing speed is slow, issue commands separately to divide the processing.

(2) Precautions for transferring files
(a) Automatically disconnecting the line

If commands are not input from the FTP client within the time set as the command input monitoring cycle, the GOT 
disconnects the line.

(b) Retaining the connection when GOT becomes offline
Even if the GOT transitions to the offline mode (such as when downloading monitor screen data), the line between the GOT 
and the FTP client is held.

(c) Precautions for transferring a recipe file
Do not use the recipe when you transfer recipe files.
If the recipe file in the data storage is deleted while the recipe is processed, the function may not be performed properly.
If the recipe file is deleted even while the recipe is not processed, the error (system alarm: recipe file error) occurs when 

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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the recipe is performed next time.
➟10.16.5 ■2 (3) Checking the connection status

(d) Precautions for overwriting a file in the GOT
When you overwrite files in the GOT using the FTP client, check that the files are properly overwritten.
When an error occurs while files are written, the files which have been written in the GOT are deleted.
Write the files again using the FTP client.

(e) Login if an FTP client goes down
If an FTP client (personal computer) goes down, wait a time longer than the command input monitoring interval or turn on 
GS400.b2 (a forced logout signal), and then log into the GOT again.
Check the connection status between the FTP client and the GOT with GS200.b2 and GS208.

(f) Powering off the GOT during access to the files in the data storage
Do not power off the GOT while the FTP client accesses the files in the data storage of the GOT.
Doing so may cause the data corruption in the data storage.

(g) Operations of the FTP client at line disconnection
If the GOT is reset or powered off when the line between the GOT and the FTP client is connected, the operations of the 
FTP client depends on the specification of the FTP client tool to be used.
Use an FTP client tool which detects the FTP server down or properly shuts down the FTP client.

(h) If the put command does not write data to the data storage
If the put command does not write data to the data storage, check that the following conditions are satisfied.

• The SD card cover of the GOT is closed.
• The SD card access switch of the GOT is turned on.
• The write-protect switch of the data storage is turned off.

(i) Time stamp of a transfer file
The time stamp of a transfer file may differ from that of the file in the GOT data storage depending on the FTP client tool to 
be used.
When the time stamps differ, check the settings of the FTP client tool.

(3) Precautions for FTP login
(a) In the event of a forgotten password

If you forget the password for FTP login, you cannot connect the FTP client with the GOT.
Reset the password in [FTP Server] in the [Controller Setting] window.

➟10.16.4 [FTP Server]

(b) Simultaneous logins from multiple FTP clients
Multiple FTP clients cannot log in to the GOT simultaneously.

(c) If the login name or password is incorrectly input on the FTP software
When you input a login name or a password for FTP login incorrectly, you may need to exit the FTP client and input them 
again depending on the FTP software to be used.

(d) If Microsoft Internet Explorer does not display the user authentication screen
When you use Microsoft Internet Explorer, the user authentication screen may not be displayed.
Input the address of the GOT in the following format.
ftp://<User name>:<Password>@<The address name or the host name of the GOT>/
Example) When "AdminPass" is set for the password
ftp://Admin:AdminPass@192.168.0.18

(4) Precautions for accessing files
Deleting certain files may cause any malfunctions to the GOT.
To prevent the GOT from operation errors, do not delete the files in the FTP server by accessing from the FTP client.

(5) Precautions for using FFFTP
When FFFTP is used with the FTP server function, [501 NLST: Options not supported] may be displayed on the screen 
and you may not be able to connect to the server.
In this case, conduct the following procedure to avoid errors.

Step 1 Open the host list on FFFTP.
Step 2 Select the [Special] tab.
Step 3 Select [Use LIST command to get file list].
Step 4 Click the [OK] button to close the dialog.
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10.16.7 Relevant settings

Set the relevant settings other than the specific settings for the FTP server function as required. The following shows the 
functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Notifying that the FTP server function is ready GS200.b1

Notifying that an FTP client is connected to the GOT GS200.b2

Notifying the number of the FTP clients connected to the GOT GS208

Forcibly disconnecting all FTP clients GS400.b2

Enabling the binary format file (*.G2□) to be read from the FTP client. GS400.b8

Specifying the number of FTP clients connectable to the GOT
GS404
(Not available to GT21 and GS21)

Specifying drive V as the current directory when logging in to the FTP server
GS423.b10
(Not available to GT23, GT21, and GS21)
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10.16.8 Troubleshooting

■1 Troubleshooting for the FTP server function
The following shows the troubleshooting for the FTP server function.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

The FTP server 
function does 
not work.

When all the bits 
of GS200 are off 
and the GOT 
does not 
respond to Ping 
*1*2

The system application (extended function) 
for the FTP server function is not installed on 
the GOT.

Write the package data, which contains system application 
(extended function) for the FTP server function, to the GOT.
➟4. COMMUNICATING WITH GOT

No IP address has been set for the GOT. Set the IP address for the GOT in the utility of the GOT.

The port number of the personal computer 
(MX Component) is different from that of the 
GOT (5011).

Set the same port number for the personal computer (MX 
Component) as that of the GOT (5011).

If any bit of 
GS200 is on and 
the GOT 
responds to Ping 
*1*2

- Refer to the troubleshooting for the functions corresponding to 
the bits which are on, and take the corrective actions.

The FTP client cannot connect to 
the line.

[Use the function of FTP Server] is not 
enabled in the FTP server setting of GT 
Designer3.

Enable [Use the function of FTP Server].

The number of connected FTP clients has 
reached the upper limit.

Perform one of the following operations, and then connect the 
FTP client again.
• Disconnect an FTP client.
• Change the number of connectable FTP clients with GS404.

(Not available to GT21 and GS21)

- Issue a ping command to the GOT and check if the GOT 
responds to it.

- Consult with a network manager.

The FTP client cannot log in. The login name or the password is incorrectly 
input.

Input a correct login name and password. (The difference 
between capital letters and small letters is distinguished.)

Files cannot be written.

The GOT cannot recognize the file name.
For the details of settable file names, refer to the following.
➟10.16.5 ■2 (2) How to specify files

The FTP client is in the reference mode. Change the mode of the function to the write mode.

Overwriting is prohibited in the FTP client 
setting. Change the FTP client setting.

The FTP client which does not send a file 
when the same file name exists in the FTP 
server is used.

Change the setting of the FTP client to enable sending 
(overwriting) files even when the same file name exists in the 
FTP server.
Delete the file which exists in the FTP server in which the file 
name is overlapped with the name of the file to be sent.

The data storage is write-protected. Cancel the write protection for the data storage.

The SD card cover of the GOT is open. Close the SD card cover of the GOT.

The SD card access switch of the GOT is 
turned off. Turn on the SD card access switch of the GOT.

The SD card is write-protected. Check that the write protection for the SD card is canceled.

Files cannot be read.

The file to be read does not exist. Use the dir or Is command to check if the file exists.

The SD card cover of the GOT is open. Close the SD card cover of the GOT.

The SD card access switch of the GOT is 
turned off. Turn on the SD card access switch of the GOT.

The SD card is write-protected. Check that the write protection for the SD card is canceled.

Files cannot be deleted.

The data storage is write-protected. Cancel the write protection for the data storage.

The SD card cover of the GOT is open. Close the SD card cover of the GOT.

The SD card access switch of the GOT is 
turned off. Turn on the SD card access switch of the GOT.

The SD card is write-protected. Check that the write protection for the SD card is canceled.
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*1 For the details of the Gateway Common Information (GS200), refer to the following.

➟12.1.3 GOT special register (GS)
*2 To check if the GOT responds to Ping, give the ping command through the personal computer to the GOT.

■2 Code and message of the FTP server function
The codes and messages related to the FTP server function are displayed on the FTP client.
The display of the codes and messages differs depending on the FTP client tool to be used.
The following shows the codes and messages sent from the GOT to the FTP client.

(1) Codes and messages in normal condition

The GOT was powered off during 
login. -

Delete the file being transferred without using it since it may be 
damaged.
(Operation of an FTP client differs depending on the 
specifications of the FTP client to be used.)

The FTP client software was forcibly 
exited during login. -

Log in to the GOT again after the command input monitoring 
cycle set in the FTP server setting.
(The GOT logs out after the time set with commands elapses.)

Symptom Details of error and cause Corrective action

Code Message Description

125 Data Connection already open; transfer starting Start of transfer

150 Opening connection. Establishment of connection for transfer

200

TYPE is now BINARY. Setting to the binary transfer mode is successful.

TYPE is now ASCII. Setting to the ASCII transfer mode is successful.

PORT command successful. PORT command is successful.

File structure set to NO RECORD The data transfer structure type is set to File. (STRU)

Command Okay.
Normal command

Command successful.

NOOP -- did nothing as requested...hah! NOOP command response

File deleted successfully. The DELE command is successful. (File deletion)

RMD command successful. The RMD command is successful. (Directory deletion)

214

The following commands are recognized. (* =>'s not 
implemented)

List of available commands (Commands marked with * are not 
available.)

Help end. HELP display end

Syntax: <Command name>... HELP display of each command

215 GOT2000 SYST command response

220 GOT2000 FTP server ready. Establishment of connection

221 User logged out. Good-Bye. Connection end

226 Closing data connection. End of connection for transfer

227 Entering Passive Mode (%d,%d,%d,%d,%d,%d) The PASV command is successful. (Socket passive mode)

230

User logged in. Logging in is successful.

Guest login ok, access restrictions apply. Guest user can log in. (Writing is unavailable.)

Guest login ok, upload directory is %s. Guest user can log in. (Writing is available.)

250

CWD command successful. The CWD (change of the current directory) command is successful.

File deleted successfully. The DELE command is successful.

File renamed successfully. The RNTO command is successful.

257 "/*****/****/**.***" is current directory. Displaying the current directory

275 MKD command successful. The MKD (creation of a directory) command is successful.

331
Password required. A password is required.

Guest login ok, send your complete e-mail address as 
password. Guest user specification

350 Requested file action pending further information. The RNFR command (setting of the target to be renamed) is 
successful.
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(2) Codes and errors in error condition

Error code Error message Description Corrective action

221 You could at least say goodbye. Command read error Reading commands has failed.
Input a correct command.

421

Timeout (%d seconds): closing connection. Connection timeout Connect the FTP client to the line 
again.

Service not available, closing control 
connection. Unavailable client connection

After another device is logged out, 
connect the FTP client to the line 
again.

Session limit reached, closing control 
connection

Upper limit error of sessions (maximum 
four sessions)

The number of sessions has 
exceeded the upper limit.
Reduce the number of sessions.

425

Can't open passive connection PASV command failure

The access from the GOT has been 
blocked by the firewall of Windows.
Allow the FTP server programs 
through the firewall of Windows.

Can't open data connection Data socket connection (accept) failure Data socket connection has failed.
Connect to the data socket again.

Can't build data connection Maximum number of retry exceedance 
error (connect)

Connection has failed within the set 
number of retry.
Check that the FTP server and the 
FTP client are properly connected.

426
Connection closed; transfer aborted. Transfer error

The data transfer has failed.
Transfer the data again or check 
the connection status.

Data connection error Data socket connection error Connect the FTP client to the line 
again.

500 Syntax error, command unrecognized. Syntax errors and commands cannot be 
recognized.

Check that syntax and commands 
are correctly input.

501 Syntax error in parameters or arguments. CWD, CDUP, XCWD, XCUP command 
failure (The parameter is not a directory.)

Specify a correct directory for the 
parameter.

504 Command not implemented for that 
parameter Parameter error of the commands Input a correct value to the 

parameter of the command.

510

Command not supported. Unsupported command
The input command is not 
supported.
Input a supported command.

Port open fails. Port open failure Opening the port has failed.
Open the port.

File open fails. File open failure
Files could not be opened.
Check that the files exist and the 
file name is correct.

530

Not logged in. Login failure

Check that the login name and 
password are correct.
Check that the login name and 
password are correctly input.

USER and PASS required Command error (The command is 
executed without logging in.) Log in and input commands.

Requested action not taken. Command execution failure Check that commands are 
available.

Can't access the file or the Directory. Access unavailable

Check that the connection target 
can be accessed.
Check that the connection target is 
allowed to be accessed.

No files found or invalid directory or 
permission problem

The specified file or directory does not 
exist.

Check that the specified file or 
directory exists.

%s:No such file or directory. The file does not exist or the required 
operation is not allowed.

Check that the file exists.
Enable the required operation and 
execute it again.

Unimplemented TYPE %d Unsupported transfer mode error Send data in a supported transfer 
mode.

%s: not a plain file RETR, SIZE, MDTM command failure (The 
file is corrupted.) Access a proper file.

551 Requested file action aborted. Input file transfer error Transfer the file again.

553 Requested action not taken. File open failure (STOR) The file may be damaged. Do not 
use the file and delete it.
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10.17 Transferring a File between the GOT and Peripheral Device (File 
Transfer Function (FTP Transfer))

10.17.1 Overview of the file transfer function (FTP transfer)

The file transfer function (FTP transfer) enables you to write a file to an external FTP server from the GOT (FTP client).
For GT21, the following models support this function.

• GT2107-W
• GT2104-R
• GT2104-PMBD
• GT2103-PMBD

You can write files including resource data to a personal computer (FTP server) by Ethernet in operating the GOT (FTP 
client).
Files are written to up to 64 FTP servers preregistered.

■1 Sending files from the GOT to the FTP server
You can write various files including the resource data to the personal computer (FTP server) in operating the GOT (FTP 
client).
This function is used to update the resource data in the personal computer by using the GOT, or for other purposes.

■2 Obtaining the resource data from the FTP server
You can read files including the resource data saved in the personal computer (FTP server) in operating the GOT.
This function is used to obtain recipe files created with the personal computer and use them with the recipe, to display 
image data saved in the personal computer on the GOT by the document display, or for other purposes.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Ethernet

GOT 
(FTP client)

GOT 
(FTP client)

GOT 
(FTP client)

Personal computer 
(FTP server)

Writing files to FTP server

Converting 
alarm log files

Obtaining 
hard copy

Collecting 
log files

Data 
storage

Data 
storage

Data 
storage

Ethernet

GOT 
(FTP client)

GOT 
(FTP client)

Personal computer 
(FTP server)

Obtaining image 
files for document 

display
Obtaining 
recipe files

The followings are saved in the 
personal computer.
  Recipe file
  Image data for document display

Receiving files from the FTP server

Data 
storage

Data 
storage
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10.17.2 Specifications of the file transfer function (FTP transfer)

■1 System application (extended function)
To use the file transfer function (FTP transfer), a system application (extended function) of [File Transfer] is required.
To incorporate the application into package data automatically, select [Use the function of File Transfer] and configure 
the settings in the [Controller Setting] window ([File Transfer]).

➟10.17.4 [File Transfer] (FTP transfer)

■2 Specifications of the FTP transfer
The following shows the specifications of the file transfer function (FTP transfer).

(1) FTP servers whose operations have been validated
For the FTP servers whose operations have been validated by Mitsubishi Electric Corporation, refer to the following.

➟List of Devices Validated to Operate with the GOT2000 Series' FTP Server Function/ File Transfer Function 
(GOT-A-0167)

■3 File access range
The GOT (FTP client) can access the FTP servers in the network to which the GOT is connected.
The GOT (FTP client) also can access GOTs (FTP server).
To connect to the FTP servers in a different network, the router is required.

■4 Required settings for the GOT and personal computer
To use the file transfer function (FTP transfer), configure the GOT (FTP client) settings and FTP server settings.
For the FTP server settings, refer to the following.

• Personal computer or others
➟Manual of the FTP server used

• GOT (FTP server)
➟10.16.4 [FTP Server]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications

Applicable FTP server
FTP server compliant with RFC 959
➟(1) FTP servers whose operations have been validated

Number of connectable FTP 
servers Max. 64

Number of file transfer settings Max. 100 (FTP transfer settings and GOT internal transfer settings in total)

Transfer mode In the stream mode, the communication is performed with binary data. PORT mode and Passive mode are supported.

Required devices for the file 
access Data storage

Number of characters for file 
path

• <GOT folder path>\<Transfer file name>: Up to 78 one-byte alphanumeric characters and symbols in total (including 
backward slash marks)

• <FTP server folder path>\<Transfer file name>: Up to 250 one-byte alphanumeric characters and symbols in total 
(including backward slash marks)

Ethernet

GOT 
(FTP server)

GOT 
(FTP client)

Personal computer 
(FTP server)

Personal computer 
(FTP server)

Router
Switching 

hub
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.17 Transferring a File between the GOT and Peripheral Device (File Transfer Function (FTP Transfer))

10 - 285



■5 PORT mode and PASV mode
(1) File transfer in the PORT mode

Step 1 Connect the control ports from the FTP client to the FTP server.
Step 2 The GOT notifies the file transfer port No. to the FTP server.
Step 3 The FTP server sends a connection request for sending the data to the FTP client using the notified port No..

If the network is protected behind the firewall, the request is refused and thus the connection is not 
established.

(2) File transfer in the PASV mode
Step 1 Connect the control ports from the FTP client to the FTP server.
Step 2 The FTP server notifies the file transfer port No. to the GOT (FTP client).
Step 3 The FTP client sends again a connection request for the data communication to the FTP server using the 

notified port No..
Even if the network is protected behind the firewall, the connection is established.

Personal computer 
(FTP server)

GOT 
(FTP client) Firewall

1.

3.

Connect the control ports 
from the FTP client to the FTP server.

The FTP server 
sends a connection 
request to the FTP 
client.

2. The GOT notifies 
the port No. 20.

: 21Control port: 21Control port

File transfer 
port : 20 Block File transfer 

port : 20

Personal computer 
(FTP server)

GOT 
(FTP client) Firewall

1.

3.

Connect the control ports 
from the FTP client to the FTP server.

The FTP client sends 
a connection request 
to the FTP server.

2. The FTP server notifies 
the port No. 5010. *1

: 21Control port

: 5010File transfer 
port

: 21Control port

File transfer 
port : 5010

*1 The port No. to be notified
     varies depending on the 
     settings of the FTP server.

 *1
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10.17.3 How to use the file transfer function (FTP transfer)

■1 System configuration
For the communication interface settings, refer to the following.

➟10.13.5 [Communication Setting]

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use. When a repeater hub is used, the number of connectable 
personal computers is as follows.
• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)
• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 For the details of applicable FTP servers, refer to the following.

➟10.17.2 ■2 (1) FTP servers whose operations have been validated
*5 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*7 For GT21, the following models support this function.

• GT2107-W

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

FTP server Connection cable*1*2, Wireless LAN access point
Maximum 
segment 
length*3

GOT (FTP client)

Option GOT model

Personal computer 
or others*4

• 10BASE-T
Shielded twisted pair cable (STP) or unshielded twisted pair cable 
(UTP): Category 3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 and 5e

100m

- (Built into GOT)

GT27
GT25
GT23

GT21 *7

GS25
GS21

GT25-J71E71-100
GT27

GT25 *8

- - GT25-WLAN
GT27 *5

GT25 *5*8

GS25 *5

• Wireless LAN access point
For the connectable wireless LAN access points and system 
devices, refer to the following Technical News.

➟List of Valid Devices Applicable for GOT2000 Series and GOT 
SIMPLE Series (for Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *6

GT25 *6*8

GS25 *6

GOT 
(FTP client)

FTP server (personal 
computer, etc.)

Wireless LAN 
access point

Connection cable

Connection cable,
wireless LAN access point
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• GT2104-R
• GT2104-PMBD
• GT2103-PMBD

*8 Not available to GT2505-V and GT25HS-V.

■2 Setting procedure
Step 1 Consider the configuration of the whole system.

• Configuration of the whole system including controllers and GOTs
• Controller settings (including device assignment)
• GOT settings (including IP address, network number, and station number)

Step 2 Connect the GOT and the controllers.

➟■1 System configuration
Step 3 Configure the communication interface settings.

➟10.13.5 [Communication Setting]
Step 4 Configure the settings for the file transfer function (FTP transfer) with GT Designer3.

➟10.17.4 [File Transfer] (FTP transfer)
10.17.5 [Destination FTP Server Setting] dialog
10.17.6 [File Transfer Setting] dialog

Step 5 Write the package data to the GOT.
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 6 Check the operation of the file transfer function (FTP transfer).

➟10.17.7 Operation of the file transfer function (FTP transfer)

10.17.4 [File Transfer] (FTP transfer)

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [File Transfer] in the [Controller Setting] window, and set the items.

1) [Use the function of File Transfer]
Enables the file transfer function.

2) [Destination FTP Server Setting]
The connection settings between the client and FTP servers are displayed in a list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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Up to 64 FTP servers can be registered.

3) [File Transfer Setting]
Lists the file transfer settings.
Up to 100 file transfer settings can be configured.

Item Description

[New] button

Click this button to add a destination FTP server setting. When the button is clicked, the 
[Destination FTP Server Setting] dialog appears. Add a new destination FTP server 
setting.
➟10.17.5 [Destination FTP Server Setting] dialog

[Edit] button

Click this button to change the contents of the selected destination FTP server setting. 
When the button is clicked, the [Destination FTP Server Setting] dialog appears. Edit the 
contents of the selected destination FTP server setting.
➟10.17.5 [Destination FTP Server Setting] dialog

[Copy] button Click this button to copy the contents of the selected destination FTP server setting.

[Paste] button
Click this button to paste the copied contents of the destination FTP server setting. When 
the button is clicked, the dialog appears on which you can specify the FTP server setting 
ID for copying. Specify the FTP server setting ID.

[Delete] button Click this button to delete the contents of the selected destination FTP server setting.

[Delete All] button Click this button to delete the contents of all the destination FTP server settings.

Item Description

[New] button
Displays the [File Transfer Setting] dialog to add a new file transfer setting.
➟10.17.6 [File Transfer Setting] dialog

[Edit] button
Displays the [File Transfer Setting] dialog to edit the selected file transfer setting.
➟10.17.6 [File Transfer Setting] dialog

[Copy] button Copies the selected file transfer setting.

[Paste] button Displays a dialog to specify the destination file transfer ID, and pastes the copied file 
transfer setting to the specified destination.

[Delete] button Deletes the selected file transfer setting.

[Delete All] button Deletes all the file transfer settings.
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10.17.5 [Destination FTP Server Setting] dialog

1) [FTP Server Setting ID]
Set the ID to specify the destination FTP server setting.
Set the number which does not overlap with that of other FTP server settings.
The setting range is [1] to [32767].

2) [Server Setting Name]
Set the name of the destination FTP server setting.
A maximum of 32 characters can be set.

3) [FTP Server Type]
Select the type of the accessed FTP server.

• [General-purpose]: Accesses a FTP server other than a PLC.
• [MELSEC]: Accesses the FTP server function of a MITSUBISHI PLC.

To access MELSEC iQ-F, select [General-purpose].
➟10.17.2 ■2 (1) FTP servers whose operations have been validated

4) [FTP Server IP Address]
Set the IP address of the destination FTP server.
The setting range is [0.0.0.0] to [255.255.255.255].

5) [User Name]
Set the user name to login to the FTP server.
Up to 32 alphanumeric characters or symbols can be set.

6) [Password]
Set the password to login to the FTP server.
Up to 32 alphanumeric characters or symbols can be set.

7) [FTP Server Connection Mode]
Set the connection mode of the FTP server.

• [PORT mode]: Establishes connection in the PORT mode.
To access MELSEC iQ-F, select [PORT mode].

• [PASV mode]: Establishes connection in the PASV mode.
This item is not selectable when [MELSEC] is selected for [FTP Server Type].

8) [Port No.]
Set the control port No. of the FTP server.
The following shows the setting range.

• [21]
• [1024] to [65535]

Use the following port No. for the file transfer port of the FTP server.
• In PORT mode: 20
• In PASV mode: Differs depending on the settings of the FTP server.

Item Description

[Remote Password] This item appears when [MELSEC] is selected for [FTP Server Type]. Enter the remote 
password for the accessed PLC (FTP server).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
3)

4)

5)

9)

2)

6)

8)7)
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9) [Connection Command String]
Set the command issued when the FTP server is connected.
Specify the command with one-byte alphanumeric characters and symbols.
Up to 10 lines with a maximum of 255 characters per line can be specified.
The available commands differ depending on FTP servers.
For details, check the manual for the FTP server.
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10.17.6 [File Transfer Setting] dialog

1) [File Transfer ID]
Set the ID to specify the file transfer setting.
Set the number which does not overlap with that of other file transfer settings.
The setting range is [1] to [32767].

2) [Transfer Setting Name]
Set the name of the file transfer setting.
Up to 32 characters can be set.

3) [Transfer Type]
Not available to GT21 and GS21.
Select [FTP Transfer].

4) [Destination FTP Server ID]
Set the destination FTP server setting ID for the file transfer.

➟10.17.5 [Destination FTP Server Setting] dialog
5) [File Transfer Direction]

Set the direction of the file transfer.
The following shows the items to be selected.

• [Write from GOT folder to FTP server folder]
• [Read from FTP server folder to GOT folder]

6) [File Transfer Trigger]
Set the trigger to execute the file transfer.

Item Description

[Trigger Type]

Set the trigger type. The following shows the items to be selected.
• [Rise]
• [Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]

➟10.17.7 ■4 Operation when the conditions of file transfer triggers are satisfied

[Trigger device]
When selecting [Rise], [Fall], [ON Sampling], or [OFF Sampling] for the trigger type, set the 
bit device as the trigger device.
➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

5)

8)

1)
3)
4)

6)

7)

9)

10)
11)
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7) [GOT Folder Name]
Set the folder path for the GOT (FTP client) to send and receive files.
Up to 76 one-byte alphanumeric characters and symbols are settable for the folder path.
The folder division symbol "\" is not required at the end.
The following drives are settable.

• Drive A
• Drive B
• Drive E
• Drive F
• Drive G
• Drive N
• Drive X (current drive)

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

For the restrictions on the folder name used in the GOT, refer to the following.
➟12.7 Restrictions for Folder Names and File Names used in GOT

Item Description

[Specification]

Select the method of specifying the GOT folder name.
• [Direct]: Select this item to enter the GOT folder name directly.
• [Device]: Select this item to specify the GOT folder indirectly with a device.

➟10.17.7 ■3 Indirect specification of the folder name and file name

[Folder Name]

When selecting [Direct] for [Specification], enter the folder name directly.
To select a GOT (FTP client) folder from the folders set in GT Designer3, click the [Folder 
List] button.
Clicking this button displays the [Folder List] dialog.
Select the save destination folder name from the list.
Only [GOT Folder Name] reflects an item selected in the [Folder List] dialog. [Transfer File 
Name] does not reflect.
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[Folder List] button

When the following functions are set in the project, the [Folder List] dialog lists the names 
of the save destination folders set for each function.
• [Comment]
• [User Alarm Observation]
• [System Alarm Observation]
• [Logging]
• [Recipe]
• [Operation Log]
• [Hard Copy]

• [Function Name]
Displays the name of the function for which the file save settings have been configured.

• [ID]
Displays the setting ID set for each function.
(Example: Alarm ID is displayed for the user alarm observation.)
This space is blank when the function has no setting ID.

• [Name]
Displays the setting name set for each function.
(Example: Alarm name is displayed for the user alarm observation.)
This space is blank when the function has no setting name.

• [Folder Name]
Displays the name of the save destination folder for the file.

• [File Name]
Displays the name of the file stored in the save destination folder.

• [Separate destinations for each GOT]
Displays the setting of [Separate destinations for each GOT] in the setting dialog of each 
function.
If any drive other than the network drive is selected as the save destination, [-] is 
displayed.

[Separate folders for each GOT]

This item is settable when drive N is specified in [Folder Name].
Creates a folder to save files for each GOT.
For the details, refer to the following.

➟5.3.15 ■4 Creating a folder for each GOT

[Example]

Displays a sample path when drive N is specified in [Folder Name].
Regardless of the entry in [Folder Name], one of the following paths is displayed.
• When [Separate destinations for each GOT] is selected: N:\192.168.3.18\LOG
• When [Separate destinations for each GOT] is deselected: N:\LOG

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the GOT folder name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.17.7 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the GOT folder name. The setting range is [8] 
to [76].

Item Description
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8) [FTP Server Folder]
Set the folder path for the FTP server to send and receive files.
To access the default folder of the FTP server, do not specify a folder.

Example) When the default folder of the FTP server is set to \root\ftp\file\
• If no folder is specified, the GOT will access the default folder (\root\ftp\file\).
• If \hoge\ is specified, the GOT will access the specified folder (\root\ftp\file\hoge\).

Up to 250 one-byte alphanumeric characters and symbols are settable for the folder path.
The maximum number of characters and available characters differ depending on the specifications of the FTP 
server.
Check the manual of the FTP server before setting.
The folder division symbol "\" is not required at the end.
For the restrictions on the folder name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

9) [Transfer File Name]
Set a transfer file name.
Up to 75 one-byte alphanumeric characters and symbols are settable for the file name.
A wildcard character can be used in the transfer file name.

➟10.17.7 ■5 Specifying the transfer file with the wild card
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

10) [File Overwrite Specification]
Set the behavior to be performed when the transfer destination folder has a file with the same name as the transfer 
file.

• [All]: Overwrites files each time.
• [Updated files only]: Overwrites an existing file in the transfer destination folder only when the time stamp of 

the transfer file is equal to or newer than that of the existing file.
In other cases, files are not transferred.

Item Description

[Specification]

Select the method of specifying the FTP server folder.
• [Direct]: Select this item to enter the FTP server folder directly.
• [Device]: Select this item to specify the FTP server folder indirectly with a device.

➟10.17.7 ■3 Indirect specification of the folder name and file name

[Folder Name] When selecting [Direct] for [Specification], enter the folder name directly.

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the FTP server folder name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.17.7 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the FTP server folder name. The setting range 
is [8] to [250].

Item Description

[Specification]

Select the method of specifying the transfer file name.
• [Direct]: Select this item to enter the transfer file name directly.
• [Device]: Select this item to specify the transfer file name with specific devices.

➟10.17.7 ■3 Indirect specification of the folder name and file name

[File Name] When selecting [Direct] for [Specification], enter the transfer file name directly.

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the transfer file name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.17.7 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the transfer file name. The setting range is [8] 
to [75].
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11) [Delete the source file after the transfer is completed]
Select this item to delete the source file after the transfer is completed.

Selection for [File Overwrite Specification]
To transfer only the logging files that are updated by the logging function, select [Updated files only].
Since the transferred files are not resent, the file transfer efficiency is increased.
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10.17.7 Operation of the file transfer function (FTP transfer)

■1 Application examples
The following shows application examples of the file transfer function (FTP transfer).

(1) Sending an alarm log file
The alarm log file created by the GOT is converted to a CSV file and transferred to the FTP server.
The file conversion is optional.
For the details of alarms, refer to the following.

➟9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

Step 1 The GOT creates the alarm log file based on the collected alarm data.
Step 2 Convert the alarm log file from the binary format to the CSV format by using the convert trigger device for 

the file.
Step 3 Transfer the converted file to the FTP server.

(a) Settings
This application example requires the following settings.

• Alarm settings

• Settings of the file transfer function (FTP transfer)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting Description Reference

[Alarm Common 
Setting]

[Convert trigger device]
Set any bit device.

➟9.1 Collecting Alarms by 
Monitoring Devices or the 
System ([Alarm])

[Convert-in-motion 
notification device]

[User Alarm 
Observation]

[Basic] tab Set the method of collecting the history. Select 
[Historical] or [Cumulative].

[Device] tab Set the target device for observation.

[File Save] tab
Select [Save alarm log files] and set the save destination 
for the log file and the storage trigger. Select [Rise] for 
the trigger type of the storage trigger.

Setting Description Reference

[Destination FTP 
Server Setting] Set any FTP server. ➟10.17.5 [Destination FTP 

Server Setting] dialog

[File Transfer 
Setting]

[Transfer Type] Select [FTP Transfer].

➟10.17.6 [File Transfer Setting] 
dialog

[File Transfer Trigger] Set [Rise].

[Transfer File Name] Set the name of the alarm log file specified in the alarm 
observation.

Personal computer 
(FTP server)

Monitoring ALM001.CSV

PLC

Error occurred

GOT (FTP client)

1. The GOT collects alarms 
and creates an alarm log file.

2. Convert the alarm log file.
Binary format → CSV format

3.Transfer the converted file 
to the FTP server.ALM001.CSVALM001.G2AALM001.G2A
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• GOT special register (GS)

(b) Action
The following shows an example of converting and transferring an alarm log file.

Step 1 Turn on the convert trigger device for the alarm log file.
The GOT starts the file conversion and the Convert-in-motion Notification device turns on.

Step 2 Turn off the convert trigger device after the start of the file conversion.
Upon completion of the file conversion, the Convert-in-motion Notification device turns off.

Step 3 Turn on the file transfer trigger.
The GOT starts the file transfer and the File Writing signal (GS990.b0) turns on.

Step 4 Turn off the file transfer trigger after the start of the file transfer.
Upon completion of the file transfer, the File Writing signal (GS990.b0) turns off.

For the convert trigger device for the alarm log file, refer to the following.
➟9.1.2 ■5 [Alarm Common Setting] dialog

Turning on the file transfer trigger automatically
In the example above, the user needs to turn on the file transfer trigger after the file conversion.
The user also needs to turn off the convert trigger device for the alarm log file and file transfer trigger after the 
start of the processing.
Using two project scripts enables these operations to be performed automatically.
The following shows an example of settings.
(1) Device

(2) Project script setting
(a) Script No.1 Set [Rise] for the trigger type. Use the Convert-in-motion Notification device for the alarm 

log file as the trigger device.
(b) Script No.2 Set [Rise] for the trigger type. Use the File Writing signal (GS990.b0) as the trigger device.

(3) Script
(a) Script No.1 set([b: GB110]); //File transfer trigger ON rst([b: GB105]); //Alarm log file convert trigger OFF
(b) Script No.2 rst ([b: GB110]); //File transfer trigger OFF

Setting Description Reference

GS990.b0 File Writing signal ➟10.17.7 ■2 (2) Write device

Convert trigger device 
for the alarm log file

1.

3.
Convert-in-motion 
Notification device 
for the alarm log file

File Writing signal 
(GS990.b0)

File transfer trigger

Turn on the convert trigger device.

After the completion of the conversion, 
turn on the file transfer trigger.

File conversion 
starts.

Fire transfer starts.

2. After the start of the conversion, 
turn off the convert trigger device.

4. After the start of the transfer, 
turn off the file transfer trigger.

Trigger device for script No.1 

Convert trigger device for the alarm log file 

File transfer trigger 

File Writing signal 

Trigger device for script No.2

Device name                                                   Device No.                                   Script which uses the device

GB100 Script No.1

GB105 Script No.1

GB110 Script No.1, script No.2

GS990.b0 Script No.2

Convert-in-motion Notification device for the 
alarm log file 
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■2 Checking the processing status
With the file transfer function (FTP transfer), you can check the file transfer status, errors, and other relevant information 
by using GOT special registers (GS).

(1) Read device
➟12.1.3 GOT special register (GS)

(2) Write device
➟12.1.3 GOT special register (GS)

Device Name Description

GS401

File Transfer Control Controls the file transfer.

b0 Clear File Transfer Error signal

Turn on this signal to clear the error code stored in the following device or to turn off 
the following signals.
• File Transfer Error No. (GS989)
• Warning signal (GS990.b14)
• File Transfer Error signal (GS990.b15)

GS402 File Transfer Timeout Time
Set the timeout period for the file transfer. The default is 3 seconds. The setting 
range is [1] to [300] second(s). When the device value is set to 0, or 301 or more, [3] 
seconds is applied.

Device Name Description

GS987 Executing File Transfer ID Notification Stores the file transfer ID of the file transfer in execution.

GS988 Communicating FTP Server ID Notification Stores the FTP server setting ID of the currently connected destination FTP server.

GS989 File Transfer Error No.
Stores the error code of an error that occurred in the file transfer.
Turn on GS401.b0 to clear the stored error code.

➟10.17.10 ■2 Error codes for the file transfer function

GS990

File Transfer Status Notifies the file transfer processing status.

b0 File Writing signal Turns on when the GOT (FTP client) writes files to the FTP server.

b1 File Reading signal Turns on when the GOT (FTP client) reads files from the FTP server.

b2 FTP Server Connection Mode 
signal

Notifies the connection mode of the GOT (FTP client) and the FTP server. ON: 
PASV mode OFF: PORT mode

b14 Warning signal
Turns on when the error with which the processing can be continued occurs during 
the file transfer. Turns off when the Clear File Transfer Error signal (GS401.b0) is 
turned on.

b15 File Transfer Error signal
Turns on when the error with which the processing cannot be continued occurs 
during the file transfer. Files cannot be transferred while this signal is on. Turns off 
when the Clear File Transfer Error signal (GS401.b0) is turned on.

GS991 Number of Transfer Target Files

Stores the total number of files to be transferred. When the transfer file name is 
specified with the wild card, the total count includes the files which are not 
transferred due to an invalid number of characters for the folder name or other 
causes. (However, the total count does not include only the files which have invalid 
names consisting of such as two-byte characters.) Holds the device value until the 
processing for the next file transfer ID is started.

GS992 Number of Transferred Files
Stores the total number of the files already transferred. The total count includes the 
files which are not transferred due to the error or other causes. Holds the device 
value until the processing for the next file transfer ID is started.
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■3 Indirect specification of the folder name and file name
When [Device] is selected for [Specification] in the folder name or file name setting, consecutive word devices starting 
from a specified device store the folder name or file name.
The number of the consecutive word devices equals half of the set value of [Maximum number of characters]. (Fractions 
are rounded up.)
In the ASCII code, store the folder name or file name in order from the lower to the upper bit of each device.
Store Null (0x00) at the end of the folder name.
Example) Specifying the [ftpclient1] folder in drive A

■4 Operation when the conditions of file transfer triggers are satisfied
The following shows an operation example of the file transfer function when the conditions of two file transfer triggers are 
satisfied sequentially.

Step 1 When the condition of file transfer trigger 1 is satisfied, the GOT starts the file transfer for file transfer ID 1.
Step 2 The File Writing signal (GS990.b0) turns on, and the Executing File Transfer ID Notification device (GS987) 

stores 1.
Step 3 While the File Writing signal (GS990.b0) is on, even if the condition of file transfer trigger 2 is satisfied, the 

GOT does not start the file transfer for file transfer ID 2.
Upon completion of the file transfer for file transfer ID 1, the File Writing signal (GS990.b0) turns off.
Then, the GOT starts the file transfer for file transfer ID 2.

Step 4 The File Writing signal (GS990.b0) turns on, and the Executing File Transfer ID Notification device (GS987) 
stores 2.
Upon completion of the file transfer for file transfer ID 2, the File Writing signal (GS990.b0) turns off.

(1) File transfer trigger at GOT startup
When the trigger type of the file transfer trigger is [Rise] and the trigger device is on at GOT startup, the trigger condition 
is satisfied.
When the trigger type is [Rise] and the trigger device is off, the trigger condition is also satisfied.

(2) File transfer trigger condition satisfied during file transfer
A file transfer trigger condition satisfied during file transfer is processed as shown below.

• Trigger for the same file transfer setting: The file transfer trigger does not start the transfer even if the condition is 
satisfied.

• Trigger for a different file transfer setting: When the file transfer trigger condition is satisfied, the GOT (FTP client) 
transfers the file after the transfer of the previous file is completed. When multiple trigger conditions are satisfied 
during the file transfer, the files are transferred in order of the file transfer setting ID.

3A      61 
D100

:       a

a :   \ f    t p   c l   i e    n t   1

b0b15
66      5C 

D101

f        \

b0b15
74      6E 

D105

t       n

b0b15
00      31

D106

Null

b0b15

1

File transfer trigger 1
(File transfer ID 1)

1.

2.

3.
File transfer trigger 2
(File transfer ID 2)

Executing File Transfer ID 
Notification (GS987)

File transfer

After the completion of the processing 
of setting No.1, the transfer starts.

File Writing signal 
(GS990.b0)

1 2

Transfer processing 
of file transfer ID 1

Transfer processing 
of file transfer ID 2

4.
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■5 Specifying the transfer file with the wild card
Use the wild card under the following conditions.

• Only [*] can be used as the wild card. Example of valid use: [ARP*.DAT] Example of invalid use: [ARP?????.DAT]
• Only one [*] can be used. However, only [*.*] is an exception. Example of valid use: [*.DAT] Example of invalid use: 

[ARP*.*]
• You can use [*] only immediately before [.] (period) for the file name. Example of valid use: [ARP*.DAT] Example of 

invalid use: [ARP*01.DAT]
• When you use [*] in the extension part of the file name, the extension must consist of the wild card only. Example of 

valid use: ARP00001.*] Example of invalid use: [ARP00001.*AT]
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10.17.8 Precautions

■1 Precautions for system configuration
(1) Connection to the intranet

If the system needs keeping secure against unauthorized access to the intranet, consult a network service provider or a 
network administrator (a person who does network planning, IP address management, and others), and include your own 
countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the intranet connection.

(2) Countermeasures against access delay
When multiple network devices (including GOTs) are connected to the same segment, the network load increases and 
therefore the communication performance between the GOT and PLC may be degraded.
The following countermeasures may improve the communication performance.
• Using the switching hub
• Reducing the number of devices the GOT monitors

(3) When a firewall is used
If a firewall disconnects the communication of the gateway function, take countermeasures such as changing the port No. 
to be protected behind the firewall.
If the system needs keeping secure against unauthorized access in changing the port No. to be protected behind the 
firewall, consult the network administrator (a person who does network planning, IP address management, and others), 
and develop your own countermeasures.
Mitsubishi Electric Corporation assumes no responsibility for consequences that may arise from system troubles due to 
the change of the port No.

■2 Precautions for using the file transfer function (FTP transfer)
(1) Precautions for system design
(a) Port No. overlap

Check if the port No. for FTP communication is not used in the connection with other equipment.
If an overlapped port No. is set, the communication with the FTP server may fail, or unexpected operation may occur in 
other equipment.

(b) Time stamp of the transfer file
The time stamp of the transfer file indicates the time taken from the destination FTP server when the file transfer to the 
destination folder is completed.
Depending on the destination FTP server, the time stamp of the transfer file may not be obtained.
In this case, the transfer file is overwritten each time regardless of the setting of [File Overwrite Specification].

(c) GOT (FTP client) time and FTP server time
When selecting [Updated files only] for [File Overwrite Specification], set the GOT (FTP client) time and FTP server time to 
be the same.
The time stamp of the transfer file indicates the time taken from the destination FTP server when the file transfer to the 
destination folder is completed.
Therefore, when the GOT (FTP client) time and FTP server time are different, the latest file may be regarded as older than 
the file transferred last time.
In this case, the file is not transferred.
Example) When the time difference is 20 minutes between the GOT (FTP client) and personal computer (FTP server)

Step 1 The GOT (FTP client) transfers the file created at 10:00.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Personal computer 
(FTP server)

GOT (FTP client) TransferARM001.G2A

Time stamp 
10:00

ARM001.G2A

Time stamp 
10:20

Time 10:00 Time 10:20
10 - 302 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.17 Transferring a File between the GOT and Peripheral Device (File Transfer Function (FTP Transfer))



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
Step 2 The time stamps of the file created at 10:10 and the file at the FTP server are compared.

Step 3 Since the latest file is recognized as being older than that at the FTP server, the GOT (FTP client) does not 
transfer the file.

Select [All] for [File Overwrite Specification] if the time difference between the installation locations of the GOT (FTP client) 
and FTP server exists.
If the time difference between the installation locations exists, the GOT time and FTP server time may differ even the both 
time are set correctly. Therefore the time stamps cannot be compared properly.

(d) Indication in the file list of the FTP server
The GOT (FTP client) is compatible with the FTP servers that use alphanumerics to show the date and time information of 
the files in the file list.
If an FTP server uses characters other than alphanumerics such as Japanese kanji in the file list, the files cannot be 
transferred.
Configure the settings including the OS setting on the FTP server so that the FTP server uses alphanumerics to show the 
information in the file list.
To check the file list of the FTP server, issue a dir command or a list command in the command prompt on a personal 
computer that is connected to the FTP server.

Example 1) When the FTP server uses alphanumerics in the file list
The FTP server is compatible with the GOT (FTP client).

Example 2) When the FTP server uses alphanumerics in the file list
The FTP server is compatible with the GOT (FTP client).

Example 3) When the FTP server uses Japanese kanji characters in the file list
The FTP server is incompatible with the GOT (FTP client).

Personal computer 
(FTP server)

GOT (FTP client)

Compare 
the time stamps

ARM001.G2A

Time stamp 
10:10

ARM001.G2A

Time stamp 
10:20

Time 10:10 Time 10:30
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(2) Precautions for transferring files
(a) Folder path and transfer file name

The total number of characters of the folder path and transfer file name must be set as shown below.
• <GOT folder path>\<Transfer file name>: 78 characters or less (including backward slash marks)
• <FTP server folder path>\<Transfer file name>: 250 characters or less (including backward slash marks)

If the total number of the characters exceeds the limits, an error occurs.
Specify the folder path and transfer file name by using one-byte alphanumeric characters and symbols.
If you use two-byte characters, the specified file cannot be transferred.

(b) Warning possibly given if the file name is specified with a wildcard character
If the file name is specified with a wildcard character, a warning may be given at a file transfer.
Even if a warning is given, the file transfer process does not stop.
However, the file transfer may fail due to other causes, such as an invalid transfer file name or write-protect transfer 
destination folder.
Check the error code stored in the File Transfer Error No. (GS989), eliminate the cause, and then perform the file transfer 
again.

➟10.17.10 ■2 Error codes for the file transfer function

(c) Offline status of the GOT
When the GOT becomes offline during the file transfer, the file transfer is interrupted.
During the file transfer, do not perform the operation that causes the GOT to be offline, such as establishing the 
communication with GT Designer3.

(d) Deleting source files after the file transfer has completed
When you make a selection to delete source files after the file transfer is complete in [File Transfer Setting], note the 
following.

• Deleting files to which the GOT refers Do not delete the files to which the GOT refers, such as a logging file, from the 
GOT folder. Otherwise, you cannot view such data on the GOT.

• Specifying the transfer file name with a wildcard character When specifying the transfer file name with a wildcard 
character, you may delete a required file unintentionally. If the transfer source folder has a required file, take one of 
the following measures. · Deselect [Delete the source file after the transfer is completed]. · When specifying the 
transfer file name with a wildcard character, check in advance that only the transfer target files are narrowed down.

(e) Handling of a file transfer error
If an error occurs in the file transfer, turn on the Clear File Transfer Error signal (GS401.b0) to turn off the File Transfer 
Error signal (GS990.b15).
While the File Transfer Error signal (GS990.b15) is on, the GOT does not start transferring the subsequent files because 
the file transfer is recognized to have an error.

(f) Using a recipe while a recipe file is transferred
Do not use the recipe while you transfer the recipe file to the GOT.
If the recipe file in the data storage is deleted while the recipe is processed, the function may not be performed properly.
If the recipe file is deleted even while the recipe is not processed, the error (system alarm: recipe file error) occurs when 
the recipe is performed next time.

(g) Power off during the access to the data storage
Do not power off the GOT while the FTP server is accessing the file in the data storage of the GOT.
Doing so may cause the data corruption in the data storage.

(h) File password when the FTP server function of a MITSUBISHI PLC is used
When the FTP server function of a MITSUBISHI PLC is used, the GOT cannot transfer a password-protected file.
Do not set a password for the file to be transferred with the file transfer function (FTP transfer).

(i) Creating a folder when the FTP server function of a MITSUBISHI PLC is used
When you use the FTP server function of a MITSUBISHI PLC, the GOT cannot create a folder in the PLC by using the 
file transfer function (FTP transfer).
Create a file transfer destination folder in advance.
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■3 Restrictions on accessing MELSEC iQ-F
When using MELSEC iQ-F as an FTP server, note the following restrictions.

(1) Setting the FTP server type
Select [General-purpose] for [FTP Server Type] in the [Destination FTP Server Setting] dialog.
If you select [MELSEC], the GOT cannot communicate with the FTP server.
For the settings of the [Destination FTP Server Setting] dialog, refer to the following.

➟10.17.6 [File Transfer Setting] dialog

(2) Remote password authentication
Do not set a remote password on the FTP server.
The GOT cannot access the FTP server that uses the remote password authentication.

(3) Access in the PASV mode
Set [FTP Server Connection Mode] to [PORT mode] in the [Destination FTP Server Setting] dialog.
The GOT cannot access the FTP server in the PASV mode.
For the settings of the [Destination FTP Server Setting] dialog, refer to the following.

➟10.17.6 [File Transfer Setting] dialog

(4) Writing files to the FTP server
Do not write files to the FTP server.
This operation is not available.
(Only reading files is available.)

10.17.9 Relevant settings

Set the relevant settings other than the specific settings for the file transfer function (FTP transfer) as required.
The following shows the functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Turning on this signal to clear an error that occurred in the file transfer GS401.b0

Setting the timeout period for FTP communication GS402

Storing the file transfer ID of the file transfer in execution GS987

Storing the FTP server setting ID of the connected FTP server GS988

Storing the error code of an error that occurred in the file transfer GS989

Notifying the file transfer processing status GS990

Storing the total number of files to be transferred GS991

Storing the total number of transferred files GS992
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10.17.10 Troubleshooting

■1 Troubleshooting for the file transfer function (FTP transfer)
The following shows the troubleshooting for the file transfer function (FTP transfer).

*1 For the details of the Gateway Common Information (GS200), refer to the following.

➟12.1.3 GOT special register (GS)
*2 To check if the GOT responds to Ping, give the ping command through the personal computer to the GOT.

■2 Error codes for the file transfer function
The following lists the error codes that are stored in the GOT special register, GS989 (File Transfer Error No.).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

The file transfer 
function (FTP 
transfer) does 
not work.

When all the bits of GS200 
are off and the GOT does 
not respond to Ping *1*2

The system application (extended function) for the 
file transfer function is not installed on the GOT.

Write the package data that contains the system 
application (extended function) for the file transfer 
function to the GOT.
➟4. COMMUNICATING WITH GOT

No IP address has been set for the GOT. Set the IP address for the GOT in the utility of the 
GOT.

The port number of the personal computer (MX 
Component) is different from that of the GOT 
(5011).

Set the same port number for the personal 
computer (MX Component) as that of the GOT 
(5011).

If any bit of GS200 is on 
and the GOT responds to 
Ping *1*2

-
Refer to the troubleshooting for the functions 
corresponding to the bits which are on, and take 
the corrective actions.

File cannot be transferred.

The system application (extended function) for the 
file transfer function is not installed on the GOT.

Write the package data that contains the system 
application (extended function) for the file transfer 
function to the GOT.
➟4. COMMUNICATING WITH GOT

The connection setting with the FTP server is not 
configured properly.

Check the followings in [Destination FTP Server 
Setting].
• FTP server IP address, connection mode, and 

port No.
• User name and password

The FTP server is not working. Check if the FTP server has stopped.

Error code Details of error and cause Corrective action

1 The connection to the FTP server has failed.

• Check the IP address of the FTP server.
• Check if a cable is connected.
• Check the connection status of the HUB.
• Check if the FTP server is working on the target device.
• Check if the setting in [Destination FTP Server Setting] is configured properly.

2

Authentication of the FTP server has failed. Check if the login username and the password for the accessed FTP server 
are correct.

The authentication using the remote password 
has failed. Check if the remote password for the PLC is correct.

3 FTP server Busy Wait until the FTP server recovers from the busy status. *1

4 FTP communication timeout
• Check if the communication line has not been physically interrupted.
• Check the communication congestion.

5 Access to the target file to be written has failed.

• Check if the write destination drive is enabled.
• Check if the write destination drive has enough available space.
• Check if the file is not write-prohibited.
• When using the GOT as the FTP server, check if the GOT is in the write 

enable mode.
• When using the FTP server function of the PLC, check if a write destination 

folder exists.
If no write destination folder exists, create one.

• When using the FTP server function of the PLC, check if a password is set 
for the file to be transferred.
If a password is set, cancel the password protection.
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*1 The status in which a request from the client cannot be accepted
*2 Even if a warning is given, the file transfer process does not stop.

6 Access to the target file to be read has failed.

• Check if the target file exists.
• Check if the file name specified in [File Transfer Setting] is correct.
• Check if the data storage has been installed on the GOT.
• Check if the SD card cover has been closed.
• Check that the SD card access switch is turned on.
• Check that the write protection for the SD card is canceled.
• When using the FTP server function of the PLC, check if a password is set 

for the file to be transferred.
If a password is set, cancel the password protection.

7 The file whose size is the file supported by the 
GOT or more was attempted to be transferred. Check if the size of the transfer file is less than 2GB.

10

• For the FTP transfer The GOT folder name is 
invalid.

• For the GOT internal transfer The transfer 
source folder name is invalid.

Check that the GOT folder name or the transfer source folder name does not 
contain invalid characters, such as two-byte characters.

11 The transfer file name is invalid. Check if the transfer file name does not include invalid characters such as two-
byte characters.

12 The transfer source folder and destination folder 
have the same path.

Set different paths to the transfer source folder and the transfer destination 
folder.

13 Drive N is specified for both the transfer source 
folder and the transfer destination folder.

Specify drive N for only one of the transfer source folder and the transfer 
destination folder.

50 The drive specification on the PLC side is 
incorrect.

When a PLC is used as a FTP server, only drive 2 (Memory card (ROM)) is 
accessible.
Check if the setting of [FTP Server Folder] specified in the [File Transfer 
Setting] dialog is correct.

100 The destination FTP server setting ID which 
does not exist has been specified.

• Check if the destination FTP server setting ID specified in [File Transfer 
Setting] is correct.

• Add the required destination FTP server setting.

200 Access to the storage device has failed when the 
file name or folder name is specified indirectly. Check if the device setting used for the indirect specification is correct.

507 The total number of characters of the folder path 
and transfer file name exceeds the limit.

Check that the total number of the characters does not exceed the limit as 
shown below.
• <GOT folder path>\<Transfer file name>: 78 characters or less (including 

backward slash marks)
• <FTP server folder path>\<Transfer file name>: 250 characters or less 

(including backward slash marks)
• <Transfer source folder path>\<Transfer file name>: 78 characters or less 

(including backward slash marks)
• <Transfer destination folder path>\<Transfer file name>: 78 characters or 

less (including backward slash marks)

600 *2
The file transfer has been skipped because the 
total number of characters of the folder path and 
transfer file name exceeds the limit. (Only when 
the file is specified with a wildcard character)

601 *2
Since invalid characters had been used for the 
transfer file name, the transfer processing was 
skipped. (only when the file is specified with the 
wild card)

Check if the transfer file name does not include invalid characters such as two-
byte characters.

602 *2
Since the write operation for the file had failed, 
the transfer processing was skipped. (only when 
the file is specified with the wild card)

• Another function might have been using the transfer file. Transfer the file 
again.

• Check if the write destination drive has enough available space.

603 *2
Since the read operation for the file had failed, 
the transfer processing was skipped. (only when 
the file is specified with the wild card)

• The file might have been deleted before being transferred. Check if all the 
files have been transferred to the destination folder.

• Check if the data storage has been installed on the GOT.
• Check if the SD card cover has been closed.
• Check that the SD card access switch is turned on.
• Check that the write protection for the SD card is canceled.

606 *2
Since the file specified with the wild card had not 
existed, the file was not transferred. (only when 
the file is specified with the wild card)

Check if the specified file name is correct.

607 *2
The file whose size is the file supported by the 
GOT or more was attempted to be transferred. 
(only when the file is specified with the wild card)

Check if the size of the transfer file is less than 2GB.

610 *2 Deleting the source file has failed. Check if the source file is in the deletable status.

Error code Details of error and cause Corrective action
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10.18 Transferring a File between the Drives (File Transfer Function (GOT 
Internal Transfer))

10.18.1 Overview of the file transfer function (GOT internal transfer)

The file transfer function (GOT internal transfer) enables you to copy or move a file to another drive or folder within the 
GOT.

10.18.2 Specifications of the file transfer function (GOT internal transfer)

■1 System application (extended function)
To use the file transfer function (GOT internal transfer), a system application (extended function) of [File Transfer] is 
required.
To incorporate the application into package data automatically, select [Use the function of File Transfer] and configure 
the settings in the [Controller Setting] window ([File Transfer]).

➟10.18.4 [File Transfer] (GOT internal transfer)

■2 Specifications of the GOT internal transfer
The following shows the specifications of the file transfer function (GOT internal transfer).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Line
A 1254

B 348

A 1254

B 348

GOT

Transfer

A:\package1

LOG00001_*.csv

LOG00001_*.csv

Copy or move

E:\package1

LOG00001_*.csv

The file transfer 
trigger is turned on.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications

Number of file transfer settings Max. 100 (FTP transfer settings and GOT internal transfer settings in total)

Required devices for the file 
access Data storage

Transfer target Files in the transfer source folder (The files in the sub folders are excluded.)

Number of characters for file 
path

• <Transfer source folder path>\<Transfer file name>: Up to 78 one-byte alphanumeric characters and symbols in total 
(including backward slash marks)

• <Transfer destination folder path>\<Transfer file name>: Up to 78 one-byte alphanumeric characters and symbols 
in total (including backward slash marks)
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10.18.3 How to use the file transfer function (GOT internal transfer)

■1 Setting procedure
Step 4 Set the file transfer function (GOT internal transfer) with GT Designer3.

➟10.18.4 [File Transfer] (GOT internal transfer)
10.18.5 [File Transfer Setting] dialog

Step 5 Write the package data to the GOT.
For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 6 Check the operation of the file transfer function (GOT internal transfer) on the GOT.

➟10.18.6 Operation of the file transfer function (GOT internal transfer)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.18.4 [File Transfer] (GOT internal transfer)

Step 1 Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.
Step 2 Select [File Transfer] in the [Controller Setting] window, and set the items.

1) [Use the function of File Transfer]
Enables the file transfer function.

2) [File Transfer Setting]
Lists the file transfer settings.
Up to 100 file transfer settings can be configured.

Item Description

[New] button
Displays the [File Transfer Setting] dialog to add a new file transfer setting.
➟10.18.5 [File Transfer Setting] dialog

[Edit] button
Displays the [File Transfer Setting] dialog to edit the selected file transfer setting.
➟10.18.5 [File Transfer Setting] dialog

[Copy] button Copies the selected file transfer setting.

[Paste] button Displays a dialog to specify the destination file transfer ID, and pastes the copied file 
transfer setting to the specified destination.

[Delete] button Deletes the selected file transfer setting.

[Delete All] button Deletes all the file transfer settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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10.18.5 [File Transfer Setting] dialog

1) [File Transfer ID]
Set the ID to specify the file transfer setting.
Set the number which does not overlap with that of other file transfer settings.
The setting range is [1] to [32767].

2) [Transfer Setting Name]
Set the name of the file transfer setting.
Up to 32 characters can be set.

3) [Transfer Type]
Select [GOT Internal Transfer].

4) [Transfer Mode]
Select the method of transferring a file.
The following shows the items to be selected.

• [Copy]
• [Move]

5) [File Transfer Trigger]
Set the trigger to execute the file transfer.

Item Description

[Trigger Type]

Set the trigger type. The following shows the items to be selected.
• [Rise]
• [Fall]
• [Sampling]
• [ON Sampling]
• [OFF Sampling]

➟10.18.6 ■4 Operation after file transfer trigger conditions being satisfied

[Trigger device]
When selecting [Rise], [Fall], [ON Sampling], or [OFF Sampling] for the trigger type, set the 
bit device as the trigger device.

➟6.2.2 Setting Trigger Types

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

5)

8)

1)
3)
4)

6)

7)

9)
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6) [Source Folder]
Specify the transfer source folder path.
Up to 76 one-byte alphanumeric characters and symbols are settable for the folder path.
The folder division symbol "\" is not required at the end.
The following drives are settable.

• Drive A
• Drive B
• Drive E
• Drive F
• Drive G
• Drive N
• Drive X (current drive)

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

For the restrictions on the folder name used in the GOT, refer to the following.
➟12.7 Restrictions for Folder Names and File Names used in GOT

Item Description

[Specification]

Select the method of specifying the transfer source folder name.
• [Direct]: Select this item to enter the transfer source folder name directly.
• [Device]: Select this item to specify the transfer source folder name with specific devices.

➟10.18.6 ■3 Indirect specification of the folder name and file name

[Folder Name]

When selecting [Direct] for [Specification], enter the folder name directly.
To select a folder from the existing ones that are set with GT Designer3, click the [Folder 
List] button to display the [Folder List] dialog.
Select the transfer source folder from the folder list.
The folder selected in the [Folder List] dialog is reflected in [Source Folder] only. (The 
folder is not reflected in [File Name].)
10 - 312 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.18 Transferring a File between the Drives (File Transfer Function (GOT Internal Transfer))



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
[Folder List] button

When the following functions are set in the project, the [Folder List] dialog lists the names 
of the save destination folders set for each function.
• [Comment]
• [User Alarm Observation]
• [System Alarm Observation]
• [Logging]
• [Recipe]
• [Operation Log]
• [Hard Copy]

• [Function Name]
Displays the name of the function for which the file save settings have been configured.

• [ID]
Displays the setting ID set for each function.
(Example: Alarm ID is displayed for the user alarm observation.)
This space is blank when the function has no setting ID.

• [Name]
Displays the setting name set for each function.
(Example: Alarm name is displayed for the user alarm observation.)
This space is blank when the function has no setting name.

• [Folder Name]
Displays the name of the save destination folder for the file.

• [File Name]
Displays the name of the file stored in the save destination folder.

• [Separate destinations for each GOT]
Displays the setting of [Separate destinations for each GOT] in the setting dialog of each 
function.
If any drive other than the network drive is selected as the save destination, [-] is 
displayed.

[Separate folders for each GOT]

This item is settable when drive N is specified in [Folder Name].
Creates a folder to save files for each GOT.
For the details, refer to the following.

➟5.3.15 ■4 Creating a folder for each GOT

[Example]

Displays a sample path when drive N is specified in [Folder Name].
Regardless of the entry in [Folder Name], one of the following paths is displayed.
• When [Separate destinations for each GOT] is selected: N:\192.168.3.18\LOG
• When [Separate destinations for each GOT] is deselected: N:\LOG

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the transfer source folder name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.18.6 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the transfer source folder name. The setting 
range is [8] to [76].

Item Description
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7) [Destination Folder]
Specify the transfer destination folder path.
Up to 76 one-byte alphanumeric characters and symbols are settable for the folder path.
The folder division symbol "\" is not required at the end.
The following drives are settable.

• Drive A
• Drive B
• Drive E
• Drive F
• Drive G
• Drive N
• Drive X (current drive)

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

For the restrictions on the folder name used in the GOT, refer to the following.
➟12.7 Restrictions for Folder Names and File Names used in GOT

8) [Transfer File Name]
Set a transfer file name.
Up to 75 one-byte alphanumeric characters and symbols are settable for the file name.
A wildcard character can be used in the transfer file name.

➟10.18.6 ■5 Specifying the transfer file with the wild card
For the restrictions of the file name used in the GOT, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

Item Description

[Specification]

Select the method of specifying the transfer destination folder name.
• [Direct]: Select this item to enter the transfer destination folder name directly.
• [Device]: Select this item to specify the transfer destination folder name with specific 

devices.

➟10.18.6 ■3 Indirect specification of the folder name and file name

[Folder Name] When selecting [Direct] for [Specification], enter the folder name directly.

[Separate folders for each GOT]

This item is settable when drive N is specified in [Folder Name].
Creates a folder to save files for each GOT.
For the details, refer to the following.

➟5.3.15 ■4 Creating a folder for each GOT

[Example]

Displays a sample path when drive N is specified in [Folder Name].
Regardless of the entry in [Folder Name], one of the following paths is displayed.
• When [Separate destinations for each GOT] is selected: N:\192.168.3.18\LOG
• When [Separate destinations for each GOT] is deselected: N:\LOG

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the transfer destination folder name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.18.6 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the transfer destination folder name. The 
setting range is [8] to [76].

Item Description

[Specification]

Select the method of specifying the transfer file name.
• [Direct]: Select this item to enter the transfer file name directly.
• [Device]: Select this item to specify the transfer file name with specific devices.

➟10.18.6 ■3 Indirect specification of the folder name and file name

[File Name] When selecting [Direct] for [Specification], enter the transfer file name directly.

[Storage Device]

When selecting [Device] for [Specification], set the start device of consecutive word 
devices that store the transfer file name.
The number of the consecutive word devices equals half of the set value of [Maximum 
number of characters]. (Fractions are rounded up.)

➟10.18.6 ■3 Indirect specification of the folder name and file name

[Maximum number of characters] Set the maximum number of characters for the transfer file name. The setting range is [8] 
to [75].
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9) [File Overwrite Specification]
Set the behavior to be performed when the transfer destination folder has a file with the same name as the transfer 
file.

• [All]: Overwrites files each time.
• [Updated files only]: Overwrites an existing file in the transfer destination folder only when the time stamp of 

the transfer file is equal to or newer than that of the existing file.
In other cases, files are not transferred.

Selection for [File Overwrite Specification]
To transfer only the logging files that are updated by the logging function, select [Updated files only].
Since the transferred files are not resent, the file transfer efficiency is increased.
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10.18.6 Operation of the file transfer function (GOT internal transfer)

■1 Application examples
The following shows an application example of the file transfer function (GOT internal transfer).

(1) Copying an alarm log file to another drive
The following shows an example of copying an alarm log file from folder Package1 on drive A to folder Package1 on drive 
E. The alarm log file is converted to the CSV format in advance.
The file conversion is optional.
For the details of alarms, refer to the following.

➟9.1 Collecting Alarms by Monitoring Devices or the System ([Alarm])

Step 1 The GOT collects alarm data and creates an alarm log file in folder Package1 on drive A.
Step 2 Convert the alarm log file from the binary format to the CSV format by using the convert trigger device for 

the file.
Step 3 Copy the converted file from folder Package1 on drive A to folder Package1 on drive E.

(a) Settings
This application example requires the following settings.

• Alarm settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting Description Reference

[Alarm Common 
Setting]

[Convert trigger device]
Set any bit device.

➟9.1 Collecting Alarms by 
Monitoring Devices or the 
System ([Alarm])

[Convert-in-motion 
notification device]

[User Alarm 
Observation]

[Basic] tab Set the method of collecting the history. Select 
[Historical] or [Cumulative].

[Device] tab Set the target device for observation.

[File Save] tab
Select [Save alarm log files] and set the save destination 
for the log file and the storage trigger. Select [Rise] for 
the trigger type of the storage trigger.

Monitoring

PLC GOT

Error occurred

Convert the alarm log file.
Binary format → CSV format

2.

ALM001.G2A ALM001.CSV

The GOT collects alarms 
and creates an alarm log file.

1.

A:\Package1

ALM001.G2A

Copy the converted file from folder Package1 
on drive A to folder Package1 on drive E.

3.

A:\Package1

ALM001.CSV
Copy

E:\Package1

ALM001.CSV
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• Settings of the file transfer function (GOT internal transfer)

• GOT special register (GS)

(b) Action
The following shows an example of converting and transferring an alarm log file.

Step 1 Turn on the convert trigger device for the alarm log file.
The GOT starts the file conversion and the Convert-in-motion Notification device turns on.

Step 2 Turn off the convert trigger device after the start of the file conversion.
Upon completion of the file conversion, the Convert-in-motion Notification device turns off.

Step 3 Turn on the file transfer trigger.
The GOT starts the file transfer and the File Writing signal (GS990.b0) turns on.

Step 4 Turn off the file transfer trigger after the start of the file transfer.
Upon completion of the file transfer, the File Writing signal (GS990.b0) turns off.

For the convert trigger device for the alarm log file, refer to the following.
➟9.1.2 ■5 [Alarm Common Setting] dialog

Turning on the file transfer trigger automatically
In the example above, the user needs to turn on the file transfer trigger after the file conversion.
The user also needs to turn off the convert trigger device for the alarm log file and file transfer trigger after the 
start of the processing.
Using two project scripts enables these operations to be performed automatically.
The following shows an example of settings.
(1) Device

Setting Description Reference

[File Transfer 
Setting]

[Transfer Type] Select [GOT Internal Transfer].

➟10.18.5 [File Transfer Setting] 
dialog

[Transfer Mode] Select [Copy].

[File Transfer Trigger] Set [Rise].

[Transfer File Name] Set the name of the alarm log file specified in the alarm 
observation. Example) ALM001.CSV

Setting Description Reference

GS990.b0 File Writing signal ➟10.18.6 ■2 (2) Write device

Convert trigger device 
for the alarm log file

1.

3.
Convert-in-motion 
Notification device 
for the alarm log file

File Writing signal 
(GS990.b0)

File transfer trigger

Turn on the convert trigger device.

After the completion of the conversion, 
turn on the file transfer trigger.

File conversion 
starts.

Fire transfer starts.

2. After the start of the conversion, 
turn off the convert trigger device.

4. After the start of the transfer, 
turn off the file transfer trigger.

Trigger device for script No.1 

Convert trigger device for the alarm log file 

File transfer trigger 

File Writing signal 

Trigger device for script No.2

Device name                                                   Device No.                                   Script which uses the device

GB100 Script No.1

GB105 Script No.1

GB110 Script No.1, script No.2

GS990.b0 Script No.2

Convert-in-motion Notification device for the 
alarm log file 
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(2) Project script setting
(a) Script No.1 Set [Rise] for the trigger type. Use the Convert-in-motion Notification device for the alarm 

log file as the trigger device.
(b) Script No.2 Set [Rise] for the trigger type. Use the File Writing signal (GS990.b0) as the trigger device.

(3) Script
(a) Script No.1 set([b: GB110]); //File transfer trigger ON rst([b: GB105]); //Alarm log file convert trigger OFF
(b) Script No.2 rst ([b: GB110]); //File transfer trigger OFF

■2 Checking the processing status
With the file transfer function (GOT internal transfer), you can check the file transfer status, errors, and other relevant 
information by using GOT special registers (GS).

(1) Read device
➟12.1.3 GOT special register (GS)

(2) Write device
➟12.1.3 GOT special register (GS)

■3 Indirect specification of the folder name and file name
When [Device] is selected for [Specification] in the folder name or file name setting, consecutive word devices starting 
from a specified device store the folder name or file name.
The number of the consecutive word devices equals half of the set value of [Maximum number of characters]. (Fractions 
are rounded up.)
In the ASCII code, store the folder name or file name in order from the lower to the upper bit of each device.
Store Null (0x00) at the end of the folder name.
Example) Specifying the [ftpclient1] folder in drive A

Device Name Description

GS401

File Transfer Control Controls the file transfer.

b0 Clear File Transfer Error signal

Turn on this signal to clear the error code stored in the following device or to turn off 
the following signals.
• File Transfer Error No. (GS989)
• Warning signal (GS990.b14)
• File Transfer Error signal (GS990.b15)

Device Name Description

GS987 Executing File Transfer ID Notification Stores the file transfer ID of the file transfer in execution.

GS989 File Transfer Error No.
Stores the error code of an error that occurred in the file transfer.
Turn on GS401.b0 to clear the stored error code.

➟10.17.10 ■2 Error codes for the file transfer function

GS990

File Transfer Status Notifies the file transfer processing status.

b0 File Writing signal Turns on during the file transfer.

b14 Warning signal
Turns on when the error with which the processing can be continued occurs during 
the file transfer. Turns off when the Clear File Transfer Error signal (GS401.b0) is 
turned on.

b15 File Transfer Error signal
Turns on when the error with which the processing cannot be continued occurs 
during the file transfer. Files cannot be transferred while this signal is on. Turns off 
when the Clear File Transfer Error signal (GS401.b0) is turned on.

GS991 Number of Transfer Target Files

Stores the total number of files to be transferred. When the transfer file name is 
specified with the wild card, the total count includes the files which are not 
transferred due to an invalid number of characters for the folder name or other 
causes. (However, the total count does not include only the files which have invalid 
names consisting of such as two-byte characters.) Holds the device value until the 
processing for the next file transfer ID is started.

GS992 Number of Transferred Files
Stores the total number of the files already transferred. The total count includes the 
files which are not transferred due to the error or other causes. Holds the device 
value until the processing for the next file transfer ID is started.

3A      61 
D100

:       a

a :   \ f    t p   c l   i e    n t   1

b0b15
66      5C 

D101

f        \

b0b15
74      6E 

D105

t       n

b0b15
00      31

D106

Null

b0b15

1
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■4 Operation after file transfer trigger conditions being satisfied
The following shows an operation example of the file transfer function when the conditions of two file transfer triggers are 
satisfied sequentially.

Step 1 When the condition of file transfer trigger 1 is satisfied, the GOT starts the file transfer for file transfer ID 1.
Step 2 The File Writing signal (GS990.b0) turns on, and the Executing File Transfer ID Notification device (GS987) 

stores 1.
Step 3 While the File Writing signal (GS990.b0) is on, even if the condition of file transfer trigger 2 is satisfied, the 

GOT does not start the file transfer for file transfer ID 2.
Upon completion of the file transfer for file transfer ID 1, the File Writing signal (GS990.b0) turns off.
Then, the GOT starts the file transfer for file transfer ID 2.

Step 4 The File Writing signal (GS990.b0) turns on, and the Executing File Transfer ID Notification device (GS987) 
stores 2.
Upon completion of the file transfer for file transfer ID 2, the File Writing signal (GS990.b0) turns off.

(1) File transfer trigger at GOT startup
When the trigger type of the file transfer trigger is [Rise] and the trigger device is on at GOT startup, the trigger condition 
is satisfied.
When the trigger type is [Rise] and the trigger device is off, the trigger condition is also satisfied.

(2) File transfer trigger condition satisfied during file transfer
A file transfer trigger condition satisfied during file transfer is processed as shown below.

• Trigger for the same file transfer setting: The file transfer trigger does not start the transfer even if the condition is 
satisfied.

• Trigger for a different file transfer setting: When the file transfer trigger condition is satisfied, the GOT (FTP client) 
transfers the file after the transfer of the previous file is completed. When multiple trigger conditions are satisfied 
during the file transfer, the files are transferred in order of the file transfer setting ID.

■5 Specifying the transfer file with the wild card
Use the wild card under the following conditions.

• Only [*] can be used as the wild card. Example of valid use: [ARP*.DAT] Example of invalid use: [ARP?????.DAT]
• Only one [*] can be used. However, only [*.*] is an exception. Example of valid use: [*.DAT] Example of invalid use: 

[ARP*.*]
• You can use [*] only immediately before [.] (period) for the file name. Example of valid use: [ARP*.DAT] Example of 

invalid use: [ARP*01.DAT]
• When you use [*] in the extension part of the file name, the extension must consist of the wild card only. Example of 

valid use: ARP00001.*] Example of invalid use: [ARP00001.*AT]

File transfer trigger 1
(File transfer ID 1)

1.

2.

3.
File transfer trigger 2
(File transfer ID 2)

Executing File Transfer ID 
Notification (GS987)

File transfer

After the completion of the processing 
of setting No.1, the transfer starts.

File Writing signal 
(GS990.b0)

1 2

Transfer processing 
of file transfer ID 1

Transfer processing 
of file transfer ID 2

4.
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10.18.7 Precautions

■1 Folder path and transfer file name
The total number of characters of the folder path and transfer file name must be set as shown below.

• <Transfer source folder path>\<Transfer file name>: 78 characters or less (including backward slash marks)
• <Transfer destination folder path>\<Transfer file name>: 78 characters or less (including backward slash marks)

If the total number of the characters exceeds the limits, an error occurs.
Specify the folder path and transfer file name by using one-byte alphanumeric characters and symbols.
If you use two-byte characters, the specified file cannot be transferred.

■2 Warning possibly given if the file name is specified with a wildcard character
If the file name is specified with a wildcard character, a warning may be given at a file transfer.
Even if a warning is given, the file transfer process does not stop.
However, the file transfer may fail due to other causes, such as an invalid transfer file name or write-protect transfer 
destination folder.
Check the error code stored in the File Transfer Error No. (GS989), eliminate the cause, and then perform the file transfer 
again.

➟10.17.10 ■2 Error codes for the file transfer function

■3 Offline status of the GOT
When the GOT becomes offline during the file transfer, the file transfer is interrupted.
During the file transfer, do not perform the operation that causes the GOT to be offline, such as establishing the 
communication with GT Designer3.

■4 Moving a file
When selecting [Move] for [Transfer Mode], note the following.

• Moving a file to which the GOT refers For a file (such as a logging file) to which the GOT refers, copy the file to another 
location instead of moving it. Otherwise, you cannot view the file on the GOT because the file is deleted from the 
source folder after the file transfer is complete.

• Specifying the transfer file name with a wildcard character When specifying the transfer file name with a wildcard 
character, you may delete a required file unintentionally. If the transfer source folder has a required file, take one of 
the following measures. · Select [Copy] for [Transfer Mode]. · When specifying the transfer file name with a wildcard 
character, check in advance that only the transfer target files are narrowed down.

■5 Transferring files in the sub folders
The files in the sub folders of the transfer source folder are not transferred.

■6 Handling of a file transfer error
If an error occurs in the file transfer, turn on the Clear File Transfer Error signal (GS401.b0) to turn off the File Transfer 
Error signal (GS990.b15).
While the File Transfer Error signal (GS990.b15) is on, the GOT does not start transferring the subsequent files because 
the file transfer is recognized to have an error.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.18.8 Relevant settings

Set the relevant settings other than the specific settings for the file transfer function (GOT internal transfer) as required.
The following shows the functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT Internal Device

10.18.9 Troubleshooting

■1 Troubleshooting for the file transfer function (GOT internal transfer)
The following shows the troubleshooting for the file transfer function (GOT internal transfer).

■2 Error codes for the file transfer function
For the error codes that are stored in the GOT special register, GS989 (File Transfer Error No.), refer to the following.

➟10.17.10 ■2 Error codes for the file transfer function

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Turning on this signal to clear an error that occurred in the file transfer GS401.b0

Storing the file transfer ID of the file transfer in execution GS987

Storing the error code of an error that occurred in the file transfer GS989

Notifying the file transfer processing status GS990

Storing the total number of files to be transferred GS991

Storing the total number of transferred files GS992

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

File cannot be transferred. The system application (extended function) for the 
file transfer function is not installed on the GOT.

Write the package data that contains the system 
application (extended function) for the file transfer 
function to the GOT.
➟4. COMMUNICATING WITH GOT
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10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile 
Function)

10.19.1 Overview of the GOT Mobile function

In this section, the "server" and "client" refer to the server and client of the GOT Mobile function.
The server (GOT) is GT27, GT25, GT SoftGOT2000, or GS25.

By using the GOT Mobile function, you can monitor a controller through the GOT from an information device, such as a 
tablet.
In the GOT Mobile function, the GOT operates as a server to provide mobile screens for clients.
Information devices, such as a tablet, use a browser as the GOT Mobile function client to access mobile screens in the 
server (GOT).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Remote control is available through a network by using GOT functions, including the SoftGOT-GOT link 
function, the remote personal computer operation function, the VNC server function, and the GOT Mobile 
function.
If these functions are used to perform remote control of control equipment, the field operator may not notice 
the remote control, possibly leading to an accident.
In addition, a communication delay or interruption may occur depending on the network environment, 
and remote control of control equipment cannot be performed normally in some cases.
Before using the above functions to perform remote control, fully grasp the circumstances of the field site 
and ensure safety.

●

When operating the server (GOT) of the GOT Mobile function to disconnect a client, notify the operator 
of the client about the disconnection beforehand.
Not doing so may cause an accident.

●

WARNING

Make sure to fully understand the GOT network interaction function before using this function to control 
the authorization among pieces of equipment to prevent simultaneous operations.
The exclusive authorization control of the GOT network interaction function can be enabled or disabled 
for each screen. (For all screens, the exclusive authorization control is disabled by default.)
Properly determine the screens for which the exclusive authorization control is required, 
and set the control by screen.
A screen for which the exclusive authorization control is disabled can be operated simultaneously from 
pieces of equipment. Make sure to determine the operation period for each 
operator, fully grasp the circumstances of the field site, and ensure safety to perform operations.

●
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After the client accesses a mobile screen, you can perform operations on the mobile screen to monitor a controller 
through the GOT.
The number of clients that can access the server (GOT) simultaneously depends on the model.

*1 This is an example of when a wireless LAN access point is used.
The wireless LAN access point is unnecessary if [Operation Mode] is set to [Access Point] in the GOT wireless LAN function.
➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])

Overlap windows and superimpose windows can be displayed on mobile screens as well.
In the GOT, base screens are created as [Base Screen] and overlap windows and superimpose windows are created as 
[Window Screen]. For mobile screens, these screens are created and used as [Mobile Screen].
The window screen is controlled by using a screen switching device.

➟■4 [Screen Switching/Window]

If an overlap window extends off the mobile screen area, the extended part is hidden (display of an off-screen window).
The overlap window can be displayed off the right side or bottom of the screen.
On a mobile screen, display of an off-screen overlap window is always enabled.
Display of an off-screen window can be disabled in the GOT but not on mobile screens.

The following shows the methods of connecting the server (GOT) and clients.
• Connection with the operator name and password-based authentication (The authentication screen appears.)
• Connection without the operator name and password-based authentication—ANDON function (The authentication 

Access to a mobile screen in the server (GOT) from a tablet

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Monitoring

Client 3 
(Smartphone)

Client 1 
(Personal computer)

Router or 
hub

Wireless LAN 
access point

Client 2 
(Tablet)

Mobile screen 1

Line A 258

Mobile screen 2

Products
Line A

Line B

558

197

A client is used to view mobile 
screens and perform operations.

Line A 258

Mobile screen 
for client 1

Products
Line A

Line B

558

197

Mobile screen 
for client 2

Mobile screen 
for client 3

Line B

258

52

Accessing, 
operating

Accessing, 
operating

Accessing, 
operating

The GOT monitors controllers and reflects 
the device values of the controllers to mobile 
screens.

Mobile screen 3

Line B

258

52

*1
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screen does not appear.)
For the authentication, refer to the following.

➟10.19.2 ■5 Authentication
For the ANDON function, refer to the following.

➟10.19.4 ANDON function

Line
A 1254

B 348

A 1254

B 348

Server (GOT) Wireless LAN 
access point

Client 1 
(Personal computer)

Client 2 
(Personal computer 

and large-screen monitor)

The client connects to the server (GOT) 
with the operator name 
and password-based authentication.

The client connects to the server (GOT) 
without the operator name 
and password-based authentication. 
(ANDON function)
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10.19.2 Specifications of the GOT Mobile function

➟■1 Operating environment
■2 Usable functions
■3 Mobile screen
■4 GOT Mobile device (VGB and VGD)
■5 Authentication
■6 Authorization control
■7 Public folder
■8 File manager
■9 Hard copy function
■10 Differences between the functions to remotely operate the GOT

■1 Operating environment

(1) License number registration
To use the GOT Mobile function, register a license number in the GOT.
For how to register the license number, refer to the following.
When GT27, GT25, or GS25 is a server

➟GOT2000 Series User's Manual (Utility)
When GT SoftGOT2000 is a server

➟GOT Mobile Function License for GT SoftGOT2000 Registration Instructions
If the license number is unregistered, you can try the GOT mobile function for a cumulative amount of 30 minutes starting 
from the GOT startup.
During the trial, the mobile screen displays a watermark saying [License unregistration.] and the remaining trail time.
Up to two clients can access the server (GOT) simultaneously.

(2) Server specifications
The following shows the server specifications.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item GT27, GT25, GS25 GT SoftGOT2000*5

Http port No. No.80 (standard), No.1024 to No. 65535 (user-
definable)

No.80 (standard), No.1024 to No. 65535 (user-
definable)*2*3*4

Maximum number of clients 
connectable simultaneously*1 5 15 per personal computer*6

Http timeout time
(Time limit to respond to a request 
from a browser)

30 seconds 30 seconds

Operating environment of personal 
computers -

OS: The following OSs compatible with Internet 
Information Services (IIS) 8.5 or later
• Microsoft Windows Server 2019 Standard (64 bit)
• Microsoft Windows Server 2016 Standard (64 bit)
• Microsoft Windows Server 2012 R2 Standard (64 bit)
• Microsoft Windows 11 Enterprise (64 bit)
• Microsoft Windows 11 Pro (64 bit)
• Microsoft Windows 10 Enterprise (64 bit, 32 bit)
• Microsoft Windows 10 Pro (64 bit, 32 bit)
• Microsoft Windows 10 IoT Enterprise 2019 LTSC (64 

bit) (English OPK)
• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 

bit) (English OPK)
Memory: Depends on the OS.
• For a 64-bit OS: 2 GB or more recommended

For Windows 11: 4 GB or more recommended
• For a 32-bit OS: 1 GB or more recommended

CoreOS Version L or later -

Other software -
The following software is required.
• Internet Information Services (IIS) 8.5 or later
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
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*1 Indicates the number of clients (browsers), not the number of information devices, which are connectable to the server 
simultaneously.
Example) When you use five browsers on a tablet to access the server (GOT), the number of clients being connected is 
counted as five.

*2 If firewall settings are configured for port numbers, open the ports as required.
*3 When using port No. 80, display the Internet Information Services (IIS) Manager dialog and click Stop in the Actions pane.
*4 Three consecutive numbers (specified port number and the following two consecutive numbers) are used.

Specify a number that comes after three or more consecutive numbers for the port number.
*5 It is recommended to use GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
*6 A total of 20 modules are connectable when the Pocket GOT mobile app and GOT Mobile function are used together.

(3) Client operating environment
Network environment is required for operation.

*1 Use a browser that supports HTML5, CSS3, JavaScript, and WebSocket Protocol (RFC 6455).
*2 Make sure to validate the operations of your browser.
*3 Internet Explorer is not supported.

■2 Usable functions

The following shows the functions that can be used on a client.

(1) Common functions

○: Available, ×: Not available

Supported OS Recommended browser *1*2*3

Microsoft Windows 10
Microsoft Edge for Windows (83 or later)
Google Chrome for Windows (version 43 or later)

Microsoft Windows 8.1
Microsoft Windows 8
Microsoft Windows 7 Service Pack 1 or later

Google Chrome for Windows (version 43 or later)

Android 4.1 or later Google Chrome for Android (version 43 or later)

iOS 8 or later Safari 8.0 or later

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Availability Remarks

System font display × The standard font of each client is used.

Option font display × -

Superimposition of objects ○ -

Base screen display ○ A mobile screen is used as a base screen.

Overlap window display ○ A mobile screen is used as overlap window 1 or 2.

Superimpose window display ○ A mobile screen is used as superimpose window 1 or 2.

Key window display ○
The standard key window for mobile screens is used.
For the details, refer to the following.
➟(a) Key window

Screen switching ○
The screen switching setting for mobile screens is used.
For the details, refer to the following.
➟(b) Screen switching

Station No. switching ×

The GOT monitoring target cannot be switched for each mobile screen 
independently.
Although the station No. switching can be performed on a client, the change 
is applied to all the clients.

Buffer memory unit No. switching ×

The GOT monitoring target cannot be switched for each mobile screen 
independently.
Although the buffer memory unit No. switching can be performed on a client, 
the change is applied to all the clients.

Language switching ○
The language switching setting for mobile screens is used.
For the details, refer to the following.

➟(c) Language switching

System information ○
The GOT system information can be used on a client.
However, the monitoring target cannot be switched on a per-client basis.
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Security authentication ○ -

Alarm observation ○ The operation results of the function on the GOT can be used on a client.

Alarm popup display ○
The alarm popup display setting for mobile screens is used.
For the details, refer to the following.

➟(d) Alarm popup display

Trigger action (project) ○ The operation results of the function on the GOT can be used on a client.

Trigger action (screen) × The operation results of the trigger action (screen) on the GOT can be used 
on a client.

Time action ○ The operation results of the function on the GOT can be used on a client.

Hard copy function × -

Comment ○ -

Figure ○
For the details, refer to the following.

➟(4) Figures that can be placed

Object ○
For the details, refer to the following.

➟(5) Objects that can be placed

GOT internal device ○

The GOT internal devices (GB and GD) can be specified for clients using the 
GOT Mobile devices (VGB and VGD).
For the details, refer to the following.

➟■4 GOT Mobile device (VGB and VGD)
The GOT internal devices (GB and GD) can be directly specified for clients 
without using the GOT Mobile devices (VGB and VGD).

SoftGOT2000 internal device ○ When GT SoftGOT2000 is set as the server (GOT), SoftGOT2000 internal 
devices (SGB and SGD) can be used.

Cursor movement × -

Operation Log ○

The operation results of the function on the GOT can be used on a client.
Logging ○

Recipe ○

Project script ○

Screen script ×
No screen script is settable for a mobile screen.
However, script operating results on the GOT can be used on a client.

Object script ×
No object script is settable for an object on a mobile screen.
However, script operating results on the GOT can be used on a client.

Multi-channel connection ×
The GOT Mobile device does not have a function to set a controller using 
multi-channel connection but can monitor a controller connected using multi-
channel connection of the GOT or GT SoftGOT2000.

Vertical display ○ The size of a mobile screen is settable in the screen property.

Function Availability Remarks
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(a) Key window
The standard key window for mobile screens is supported.
User-created windows are not supported.
When using a tablet or smartphone, input characters with the software keyboard.

The minimum width of the standard key window is 420 dots.
Note that the actual display size of the standard key window varies with the resolution set on the client or the contents 
displayed on the key window.
Check the actual size of the key window size in the browser.
The following shows the setting items of the standard key window for mobile screens.

1) Input value display
Displays the input value.

2) Current value display
Displays the current value of the device.

3) Input range display
Displays the valid input range.
(This item is not displayed for the text input.)
The displayed input range depends on the number of displayed digits which is set for the numerical input.
The following shows the meaning of displayed symbols.

• [INPUT]: Value to be input
• [<]: The left side of the symbol is less than the right side.
• [<=]: The left side of the symbols is less than or equal to the right side.
• [==]: The left side of the symbols is equal to the right side.
• [!=]: The left side of the symbols differs from the right side.

4) [OK] key (Enter key)
Confirms the input value.

5) [CANCEL] key
Cancels the input value.

Standard key window 
for mobile screens

Software keyboard

1)

3)
2)

4)
5)
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(b) Screen switching
You can switch between mobile screens with the screen switching device dedicated to mobile screens.
This device is set independently of the GOT environmental setting.
Therefore, when you switch between mobile screens on a client, the screen displayed on the GOT is not switched 
coincidentally.
To display different mobile screens on each client simultaneously, set a GOT Mobile device (VGB or VGD) for the screen 
switching device dedicated to mobile screens.

➟■4 GOT Mobile device (VGB and VGD)
Example) When [Points] is set to 1000 and [First Device] is set to GD10000 in the device (VGD) allocation setting

On a mobile screen, when screen switching is performed for the overlap window which is being moved, that overlap 
window is switched.

For the screen switching setting for mobile screens, refer to the following.
➟10.19.6 ■4 [Screen Switching/Window]

Wireless LAN 
access point

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Client 1

Products
Line A

Line B

558

197

Mobile screen switching device: VGD100(GD10100)
Device value: 0 → 5

Screen switching device for the GOT: GD500
Device value: 0 → 5

Client 2

Mobile screen switching device: VGD100(GD11100)
Device value: 0 → 8
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(c) Language switching
You can switch the languages of mobile screens with the language switching device dedicated to mobile screens.
Therefore, when you switch the languages of mobile screens on a client, the display language on the GOT is not switched 
coincidentally.
To switch between languages on a per-client basis, set a GOT Mobile device (VGB or VGD) for the language switching 
device dedicated to mobile screens.

➟■4 GOT Mobile device (VGB and VGD)
Example) When [Points] is set to 1000 and [First Device] is set to GD10000 in the device (VGD) allocation setting

Except for the language switching device dedicated to mobile screens, the language switching settings configured in the 
[Environmental Setting] window are applied to the clients.
(The language switching settings are common to the GOT and the clients.)
The language switching device dedicated to mobile screens is settable when the language switching is enabled in the 
[Environmental Setting] window.
For the setting of the language switching device for mobile screens, refer to the following.

➟10.19.6 ■5 [Language Switching]

(d) Alarm popup display
You can use the alarm popup display dedicated to mobile screens.
The alarm popup display settings are not common to the GOT and the clients.
To use the alarm popup display on both the GOT and the clients, configure the alarm popup settings for the GOT and the 
mobile screens independently.
For the alarm popup display for mobile screens, some setting items have restrictions as shown below.

• [Basic] tab
[Close up the space between alarm comments] is not settable.
[Touch Mode] can be set to [None] or [Stage Hierarchy Switching] only.

• [Text Style] tab
[Font] is not settable.

When a mobile screen with alarm popup display settings configured is used as an overlap window screen or superimpose 
window screen, the settings become disabled.
For the alarm popup display settings, refer to the following.

➟10.19.6 ■8 [Alarm Popup Display]

For the alarm popup display for mobile screens, an opaque popup window appears in a user-specified background color.

(2) Utility function
The utility function cannot be used on clients.

(3) Extended functions
The following extended functions are usable.
• GOT network interaction
• Operator authentication

Wireless LAN 
access point

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Client 1

製品
ライン A

ライン B

558

197

Language switching device for 
mobile screens: VGD101(GD10101)
       Japanese display

Language switching device for the GOT: GD500
       English display

Client 2

 A
558

Mobile screen switching device: 
VGD101(GD11101)
       Chinese display

GOT Graphic Ver.2
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(a) Screen security (level authentication and operator authentication)
For the screen security on clients, the authentication method set in [Security] in the [Environmental Setting] window is 
applied.
(The authentication method is common to the GOT and the clients.)
When the level authentication is used, the GOT and each client can display a screen according to their security levels.
For the clients, the security level device (Security Level External Control device) dedicated to mobile screens is used for 
the level authentication.
To display a screen with different security levels on each client, set a GOT Mobile device (VGB or VGD) for the Security 
Level External Control device.
Except for the Security Level External Control device dedicated to mobile screens, the screen security settings configured 
in [Security] in the [Environmental Setting] windows are applied to the clients.
Example) When [Points] is set to 1000 and [First Device] is set to GD10000 in the device (VGD) allocation setting

When the operator authentication is used, you can log in or out from the GOT and each client with different operator 
accounts.
Configure the operator authentication settings for the GOT and the clients independently.
On the clients, the operator authentication through an external authentication device (such as a barcode reader or RFID 
controller) is not available.

For the screen security setting for clients, refer to the following.
➟10.19.6 ■7 [Security]

For the screen security setting for the GOT, refer to the following.
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Wireless LAN 
access point

Line
A 1254

B 348

A 1254

B 348

Server (GOT)
Client 1

製品
ライン A

ライン B

558

197

Security Level External Control device: VGD601(GD10601)
→ Security level 5Security level device: GD600

 → Security level 10

Client 2

 A
558

Security Level External Control device: VGD601(GD11601)
→ Security level 3

Wireless LAN 
access point

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Client 1

製品
ライン A

ライン B

558

197

Operator name: TARO
Password: Eagle-010

Security level 10

Client 2

製品
ライン A

558

Operator name: JIRO
Password: Penguin-005

Security level 5

Operator name: SABURO
Password: Sparrow-003

Security level 3
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(4) Figures that can be placed
The following shows the figures that can be placed on mobile screens.

○: Available, ×: Not available

For the figures on mobile screens, some setting items have restrictions.

(a) [Lamp Feature] tab and [Trigger] tab
The lamp feature and trigger settings are not available.
Therefore, a figure cannot be displayed in different styles according to the conditions. In this case, use a lamp object 
instead.

(b) [Font], [Direction], and [KANJI Region]
Each client displays characters in its standard font.
Therefore, the font, orientation of characters, and KANJI region are not settable with GT Designer3.
To change the font or KANJI region, change the standard font of the client used.
The orientation of characters cannot be changed.

(c) [Layer]
For mobile screens, the layer setting is not available.
Figures and objects are always displayed in the order specified with GT Desinger3.

Figure Availability Restrictions

Text ○ • [Font], [Direction], and [KANJI Region] are not settable.

Logo text ○ -

Line ○

• The [Lamp Feature] and [Trigger] tabs are not settable.

Line freeform ○

Rectangle ○

Polygon ○

Circle ○

Arc, sector ○ -

Table ○ -

Scale ○ -

Piping ○
• The [Lamp Feature] and [Trigger] tabs are not settable.
• [Layer] is not settable.

Paint × -

Import image data ○ -

Import DXF data ○ -

Import IGES data ○ -
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(5) Objects that can be placed
The following shows the objects that can be placed on mobile screens.

○: Available, ×: Not available

Object Availability Restrictions

Touch switch

Switch ○

• In [Action List] of the [Action] tab, [Station No. Switching] and [Key Window 
Display] are not selectable.

• In the [Style] tab, [Reverse Switch Area] is not settable.
• In the [Text] tab, [Font] is not settable.
• The [Script] tab is not settable.
• In the [Extended] tab, [Buzzer], [KANJI Region], and [Layer] are not settable.

Bit switch ○ • In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [KANJI Region] and [Layer] are not settable.Word switch ○

Go to screen switch ○
• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [Buzzer], [KANJI Region], and [Layer] are not settable.

Change station No. switch × -

Special function switch ○

• In the [SP Function] tab, items other than the following ones are not 
selectable for [Switch Action].
[Password (Security Level)]
[Login/Logout (Operator)]
[Password Change (Operator)]

• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [Buzzer], [KANJI Region], and [Layer] are not settable.

Key window display switch × -

Key code switch ○

• Becomes active when either of the following is selected for [Key Code Type] 
in the [Key Code] tab.
[Alarm Display]
[Historical Trend Graph/Historical Data List]

• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [Buzzer], [KANJI Region], and [Layer] are not settable.

Lamp

Bit lamp ○
• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [KANJI Region] and [Layer] are not settable.
• The [Script] tab is not settable.

Word lamp ○

• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [KANJI Region] and [Layer] are not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Lamp area × -

Numerical display ○

• In the [Device] tab, [Font] is not settable.
• In the [Extended] tab, [Display Mode], [KANJI Region], and [Layer] are not 

settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Numerical input ○

• In the [Device] tab, [Font] is not settable.
• In the [Extended] tab, the following items are not settable.

[Display Mode], [Move Destination ID], [Display input value on destination 
object location], [Input data using Bar Code/RFID], [KANJI Region], and 
[Layer]

• The [Operation] tab is displayed instead of the [Operation/Script] tab.
The object script settings are not available.

• Use the standard key window for numerical input.
Key code switches cannot be used.

Text display ○

• In the [Device/Style] tab, [Font] and [Reverse] are not settable.
• In the [Extended] tab, [Display Mode], [KANJI Region], and [Layer] are not 

settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Text input ○

• In the [Device/Style] tab, [Font] and [Reverse] are not settable.
• In the [Extended] tab, the following items are not settable.

[Display Mode], [Move Destination ID], [Display input value on destination 
object location], [Kana-Kanji/Pinyin Conversion], [Input data using Bar Code/
RFID], [KANJI Region], and [Layer]

• The [Operation] tab is displayed instead of the [Operation/Script] tab.
The object script settings are not available.

• Use the standard key window for numerical input.
Key code switches cannot be used.
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For the objects on mobile screens, some setting items have restrictions.

Date/Time display × -

Comment display

Bit comment ○ • In the [Text/Style] tab, [Font] and [Display the comments in Windows fonts] 
are not settable.

• In the [Extended] tab, [Display Mode], [KANJI Region], and [Layer] are not 
settable.

Word comment ○

Simple comment ○ • [Font], [Reverse], and [Layer] are not settable.

Parts display × -

Parts movement × -

Historical data list display ○

• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [KANJI Region] and [Layer] are not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Alarm display (user) ○ • In the [Alarm Setting] tab, [Operation] is not selectable for [Touch Mode].
• In the [Text] tab, [Font] and [KANJI Region] are not settable.
• In the [Style] tab, [Text color on cursor display] is not settable.
• In the [Extended] tab, [Layer] is not settable.

Alarm display (system) ○

Simple alarm display × -

System alarm display ○ • [Font] and [Layer] are not settable.

Recipe Display (Record List) × -

Line graph ○ • In the [Style] tab, [Font] is not settable.
• In the [Extended] tab, [Layer] is not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Trend graph ○

Bar graph ○

Statistics bar graph ○ • In the [Style] tab, [Font] is not settable.
• In the [Extended] tab, [Layer] is not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.
Statistics pie graph ○

Scatter graph ○

• In the [Style] tab, [Font] is not settable.
• In the [Extended] tab, [Store Memory] and [Layer] are not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Historical trend graph ○

• In the [Style] tab, [Font] is not settable.
• In the [Extended] tab, [Layer] is not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Graphical Meter ○

• In the [Text] tab, [Font] is not settable.
• In the [Extended] tab, [KANJI Region] and [Layer] are not settable.
• The [Operation] tab is displayed instead of the [Operation/Script] tab.

The object script settings are not available.

Level object × -

Panelmeter × -

Slider × -

Document display × -

Video/RGB display object × -

Script Parts × -

Set overlay screen ○

• In the [Set Overlay Screen] window, only mobile screens are listed in the 
[Screen Selection] tree.

• In the [Number Specification] window, [Screen Type] is fixed to [Mobile 
Screen].

Window position ○
• This is enabled only when a mobile screen is displayed as the base screen.

This is disabled when a mobile screen is displayed as an overlap window or 
superimpose window.

Key window object × -

Hyperlink ○ -

Object Availability Restrictions
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(a) Object script
No object script is settable for an object on a mobile screen.
Create a mobile screen without object scripts.

(b) Font and KANJI region
Each client displays characters in its standard font.
Therefore, the font and KANJI region are not settable with GT Designer3.
To change the font or KANJI region, change the standard font of the client used.

(c) Layers and display mode
For mobile screens, the layer settings are not available.
Therefore, the display mode ([Transparent] or [XOR]) of an object is not settable.
Figures and objects are always displayed in the order specified with GT Desinger3.

(d) Set overlay screen object
Only mobile screens can be called.
You cannot call another mobile screen from a called mobile screen.

■3 Mobile screen

The mobile screen is a monitor screen dedicated to clients.
(The GOT cannot display mobile screens.)
Since the screen size is settable for each mobile screen, you can create mobile screens for each client according to the 
client display size.

For the functions, figures, and objects available on mobile screens, refer to the following.
➟■2 Usable functions

Mobile screens are created with GT Designer3, and the mobile screen data is contained in the GOT project.
For information on how to create a mobile screen, refer to the following.

➟10.19.3 ■7 Usage
A created base screen or window screen can be copied to a mobile screen.
For details, refer to the following.

➟10.19.3 ■5 Copying a base screen or window screen to a mobile screen

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Wireless LAN 
access point

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Client 1 
(Personal computer)

Mobile screen 1

Line A 258

Client 2 
(Tablet)

Mobile screen 2

Products
Line A

Line B

558

197

Client 3 
(Smartphone)

Mobile screen 3

Line B

258

52

Line A 258

Mobile screen 1

Products
Line A

Line B

558

197

Mobile screen 2 Mobile screen 3

Line B

258

52

Create mobile screen 1 to 3 dedicated to each 
client.
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(1) Mobile screen specifications

(a) Font and KANJI region
Each client displays characters in its standard font. Therefore, the font and KANJI region are not settable with GT 
Designer3.
To change the font or KANJI region, change the standard font of the client used.

(b) Layers and display mode
For mobile screens, the layer settings are not available.
Figures and objects are always displayed in the order specified with GT Desinger3.

■4 GOT Mobile device (VGB and VGD)

The GOT Mobile devices (VGB and VGD) are virtual devices usable for a client.
Assign GOT internal devices (GB and GD) to GOT Mobile devices for a client. 
Thus, the GOT Mobile devices are used as internal devices for the client.
Multiple clients are controllable individually by assigning different GOT internal devices for each client.
Example) When the screen switching is performed simultaneously on multiple clients

(1) Setting range and settable devices

*1 Do not assign GB0 to GB63 to the GOT Mobile device because these internal devices (GB0 to GB63) are already assigned for 
the GOT system.

Equipment Screen size (width × height) (dots) Number of screens 
registrable

Registrable screen 
number

Number of 
simultaneously 

displayable screens

Personal computer, tablet, 
or smartphone (client) 16 to 3000 × 2 to 3000 4096 0 to 32767 5

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device assigned to VGD0 for each client
   Client 1: GD10000
   Client 2: GD11000
   Client 3: GD12000

Mobile screen switching device: VGD0

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Client 1

Products
Line A

Line B

558

197

Mobile screen No. 1 
is displayed.

VGD0 stores 1.
(GD10000 =1)

Client 2

Mobile screen No. 2 
is displayed.

Line B

258

52

VGD0 stores 2.
(GD11000 = 2)

Client 3

Mobile screen No. 3 
is displayed.

Line A

258

VGD0 stores 3.
(GD12000 = 3)

Target device Setting range of the GOT 
Mobile device

GOT Mobile device No. 
representation

Number of the GOT internal devices 
that can be assigned

GOT internal device that can 
be assigned

GOT Mobile bit register 
(VGB) VGB0 to VGB32767 Decimal number 32 to 32768

(in 32-point units) GB64 to GB65535*1

GOT Mobile data register 
(VGD) VGD0 to VGD32767 Decimal number 2 to 32768

(in 2-point units) GD0 to GD65535
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(2) How to assign a GOT internal device
Set the number of devices to be assigned, and specify the first device assigned for client 1. Then, the set number of 
consecutive devices (starting from the specified first device) are automatically assigned to the GOT Mobile devices for 
each client.
Example) Assigning 1000 GOT internal devices (GD) to the GOT Mobile devices (VGD) for client 1, client 2, and client 3

For the GOT Mobile device setting, refer to the following.
➟10.19.6 ■3 [Device Allocation Setting]

(3) Clearing the values of the GOT Mobile devices
If you select [Initialize the devices (VGD, VGB) at the time of client connection] in the [GOT Mobile Setting] window 
([Device Allocation Setting]), the values of the GOT Mobile devices assigned to a client are cleared when the client 
connects to the GOT.
If you deselect the item, the assigned devices retain the values stored in the last session.

➟10.19.6 ■3 [Device Allocation Setting]

■5 Authentication

The following shows the methods of connecting the GOT and clients.
• Connection with the operator name and password-based authentication (The authentication screen appears.)
• Connection without the operator name and password-based authentication—ANDON function (The authentication 

screen does not appear.)
For the ANDON function, refer to the following.

➟10.19.4 ANDON function

For the connection with the operator name and password-based authentication, a target client displays mobile screens 
upon being authenticated.
The authentication method is selectable between the GOT Mobile exclusive authentication and the operator 
authentication.
For the authentication setting, refer to the following.

➟10.19.6 ■2 [Authentication Setting]

Word device assignment setting
  Number of devices: 1000
  First device: GD10000

Client 2

Devices assigned for client 2
   VGD0 to VGD999: GD11000 to GD11999

Client 3

Devices assigned for client 3
   VGD0 to VGD999: GD12000 to GD12999

Client 1

Devices assigned for client 1
   VGD0 to VGD999: GD10000 to GD10999

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(1) GOT Mobile exclusive authentication
This authentication method is dedicated to the GOT Mobile function.
The account dedicated to the GOT mobile function is used for the authentication.
The operator management information is not used.
After the GOT Mobile authentication succeeds, you can log in using the operator authentication or the level 
authentication.
Two types of accounts are used in the GOT Mobile authentication: administrative operator account and guest operator 
account.
When authenticated with the administrative operator account, the client can obtain the authorization of the GOT network 
interaction function.
You can view a mobile screen in which the authorization control is enabled, and operate the objects on the mobile screen.
When authenticated with the guest operator account, the client cannot obtain the authorization of the GOT network 
interaction function.
You can view a mobile screen in which the authorization control is enabled, but cannot operate the objects on the mobile 
screen.

One administrative operator account and one guest operator account are settable for each project.
For the setting method, refer to the following.

➟10.19.6 ■2 [Authentication Setting]

(2) Operator authentication
This authentication needs an operator account in the operator management information file.
Make sure to preconfigure the operator authentication setting in [Security] in the [Environmental Setting] window.
Otherwise, the authentication method of the GOT Mobile function is fixed to the GOT Mobile exclusive authentication.
After the operator authentication succeeds, you can view mobile screens according to the operator account security level.
The authenticated client can obtain the authorization of the GOT network interaction function, regardless of the operator 
account security level.
If the operator account is logged out, the GOT automatically disconnects the client.
Even if the operator account is logged out because of the automatic logout time, the client becomes disconnected from 
the GOT.
The operator switching is not available on a client that is connected to the GOT.
To switch between operators, disconnect the target client from the GOT, and then perform the authentication with another 
operator account.
For the details of the operator authentication, refer to the following.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

Line
A 1254

B 348

A 1254

B 348

Server (GOT)

Administrative operator

Viewable
Operable

Products
Line A

Line B

558

197

Guest operator

Products
Line A

Line B

558

197

Viewable
Not operable

PLC
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■6 Authorization control

You can prevent simultaneous operations from multiple clients and the GOT by enabling the authorization control.
Base screens, overlap windows, and superimpose windows for GOT Mobile are the targets for authorization control, which 
is the same as authorization control of GOT screens.
To control the authorization among clients and the GOT, use the GOT network interaction function in combination.
For the details of the GOT network interaction function, refer to the following.

➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])
You can check the authorization status of each client and control the authorization with the following devices.

(1) Operational Authority Status Notification device
This device notifies the authorization status of each client in a control group.
Specify this device using the GOT Mobile device (VGD) or the word-specified GOT Mobile device (VGB).

➟10.19.6 ■9 [Exclusive Control of Operational Authority]

(2) Operational Authority Status Control device
This device controls the authorization among the clients and the GOT in a control group.
Specify this device using the GOT Mobile device (VGD) or the word-specified GOT Mobile device (VGB).

➟10.19.6 ■9 [Exclusive Control of Operational Authority]

■7 Public folder

The server (GOT) uses the public folder to provide files for clients.
To access a file in the public folder on the server (GOT), specify the URL of the file in your browser.
No authentication is performed to access the public folder.
Application example 1) Accessing a manual PDF file in the public folder from a client

Application example 2) Saving a logging file to the public folder and accessing the file from a client

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Bit number Function Description

b0 Notifies whether the equipment obtains 
the authorization. Turns on when the equipment obtains the authorization.

b1 Notifies whether the authorization control 
is enabled in the screen being displayed. Turns on when the authorization control is enabled in the screen being displayed.

b2 to b15 - Use prohibited

Bit number Function Description

b0 Disables the automatic acquisition of the 
authorization.

When this bit turns on, the automatic acquisition of the authorization becomes 
disabled.
On unauthorized equipment, even if you switch a screen to another screen in 
which the authorization control is enabled, the equipment cannot automatically 
obtain the authorization.

b1 to b15 - Use prohibited

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Client 
(Tablet)

Line
A 1254

B 348

A 1254

B 348

Server (GOT)
(IP: 192.168.3.18)

PLC

A:\package1\userdata

Manual.pdf
Access the public folder by specifying 
the URL in the browser:

Public folder

1.

2.
Manual.pdf

http://192.168.3.18/userdata/Manual.pdf

Obtain the PDF file.
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(1) Enabling the public folder
To allow clients to access the public folder, select [Allow external access to GOT public folder] in [Basic Setting] in the 
[GOT Mobile Setting] window.

➟10.19.6 ■1 [Basic Setting]

(2) Creating the public folder
The public folder is created by the user.
Under the package folder of the GOT, create the public folder named "userdata".
The package folder is in the current drive.
For the details of the current drive, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer
If a sub folder is created under the public folder, files in the sub folder are also accessible.
Create sub folders when necessary.

(3) Accessing a file in the public folder from a client
To access a file in the public folder, enter the URL of the file in the address bar of the browser in the following format.
http://GOT IP address/userdata/sub folder name/file name
(Enter the sub folder name only when the sub folder is created.)
Example) http://192.168.3.18/userdata/subfolder1/AAM00001.csv
When you place a hyperlink object on a mobile screen and specify the URL of a file in the public folder in the object setting, 
touch the object to access the file.
For the detail of the hyperlink object, refer to the following.

➟8.33 Placing a Hyperlink on a Mobile Screen

Client 
(Tablet)

Server (GOT)
IP: 192.168.3.18

PLC

A:\package1\userdata

L0G00001_0001.csv

Buffering area

Convert a logging file to 
the CSV format, and then 
save the CSV file to the 
public folder.

Public folder
1.

Obtain the logging file (CSV).

http://192.168.3.18/userdata/L0G00001_0001.csv

Access the public folder by specifying 
the URL in the browser:

2.

3.

L0G00001_0001.csv

package1 

userdata

Current drive

Package folder

File

Sub folder

Public folder

File
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■8 File manager

On the file manager screen, you can view the folders and files in the public folder, or perform manipulations on them such 
as copying.

For the public folder, refer to the following.
➟■7 Public folder

To manipulate the folders and files in the public folder, turn on GS1896.b1.
To limit users to perform the manipulations, specify a security level with GS1892.
When a security level (0 to 15) is specified with GS1892, the users with the specified security level and higher are allowed 
to perform the manipulations.

➟12.1.3 GOT special register (GS)

(1) File manager screen
To display the file manager screen, touch the extended function button on the operation menu bar on a mobile screen, 
and select [File manager] from the displayed menu.

➟10.19.3 ■7 (2) Operation menu bar on the mobile screen
The mobile screen is not operable while the file manager screen is being displayed.
Touch a row to open the corresponding folder or file.

1) Return button
Moves to the parent folder.

2) Update button
Updates the contents of the file manager screen.

3) Directory button
Displays the directory tree to the open folder.
Touch the folder to move to in the tree structure.

4) Manipulation button

Item Description

Viewing The folders and files in the public folder are viewable.

Manipulations

The following manipulations are supported.
• Copy
• Cut (GT SoftGOT2000 does not support this manipulation for folders.)
• Paste
• Rename
• New folder
• Delete (GT SoftGOT2000 does not support this manipulation for folders.)
Folders and files cannot be moved between the public folder and the other folders.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4)

7)

9) 10) 11)

12)

5)

6)

8)
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Displays the menu for manipulating the folders and files listed.

5) Address bar
Displays the path to the open folder.

6) Select all checkbox
Selects all folders and files.

7) Select checkbox
Selects a folder or file to be manipulated.

8) [Name]
Displays the folder and file names.

9) [Size]
Displays the size of files.

10) [Updated]
Displays the updated date and time of folders and files.

11) [Extension]
Displays the filename extensions.

12) Close button
Closes the file manager screen.

■9 Hard copy function

The hard copy function captures the current mobile screen in PNG format and outputs it to a new tab in the browser.
To execute the hard copy function, touch the extended function button on the operation menu bar on a mobile screen, 
and select [Hard Copy] from the displayed menu.

➟10.19.3 ■7 (2) Operation menu bar on the mobile screen
The image is displayed in full size (100%) that is set on GT Designer3.
Save the displayed image as necessary.

The following items are not captured in the screenshot by the hard copy function.
• Mouse pointer
• Operation menu bar on the mobile screen
• Authorization popup display
• Alarm popup display
• Key window
• Dialog

■10 Differences between the functions to remotely operate the GOT

For the differences between the functions to remotely operate the GOT, refer to the following.
➟10.5.2 ■7 Differences between the functions to remotely operate the GOT

Item Description

[Copy] Copies the selected folder or file.

[Cut]
GT SoftGOT2000 does not support this manipulation for folders.
Cuts the selected folder or file.

[Paste] Pastes the copied or cut folder or file in the open folder.

[Rename]
Renames the selected folder or file.
For restrictions on the folder name and file name, refer to the following.

➟12.7 Restrictions for Folder Names and File Names used in GOT

[New folder] Creates a folder.

[Delete]
GT SoftGOT2000 does not support this manipulation for folders.
Deletes the selected folder or file.
If you delete a folder, the files in the folder will also be deleted even though they are in use.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.19.3 How to use the GOT Mobile function

➟■1 System configuration
■2 Setting procedure
■3 Setting GT27, GT25, or GS25 as a server
■4 Setting GT SoftGOT2000 as a server
■5 Copying a base screen or window screen to a mobile screen
■6 Setting on the client
■7 Usage

■1 System configuration

The following shows the system configuration of the GOT Mobile function.

*1 The applicable destination to connect the twisted pair cable depends on the configuration of the Ethernet network system.
Connect to the applicable Ethernet module, hub, transceiver, wireless LAN adapter (NZ2WL-JPA or NZ2WL-JPS), or other 
system equipment according to the Ethernet network system.
Use the cable, connector, or hub that meets the IEEE802.3 10BASE-T/100BASE-TX standard.
For the controller to which the wireless LAN adapter can be connected and how to configure the settings for the wireless LAN 
adapter, refer to the manual of the wireless LAN adapter you use.

*2 A straight cable is applicable.
When the GOT is directly connected to the personal computer via Ethernet cable, a cross cable is applicable.

*3 The length between the hub and node.
The maximum length depends on the Ethernet equipment you use.
When a repeater hub is used, the number of connectable personal computers is as follows.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Client
(Personal computer, 

tablet, or 
smartphone)

Connection cable*1*2,
wireless LAN access point

Maximum 
segment 
length*3

Server (GOT)

PLC
Option GOT 

model

Select by each user

• 10BASE-T
Shielded twisted pair cable (STP) or 
unshielded twisted pair cable (UTP): Category 
3, 4, and 5

• 100BASE-TX
Shielded twisted pair cable (STP): Category 5 
and 5e

100m

- (Built into GOT)
GT27
GT25
GS25

For the system 
configuration 
between the GOT 
and the PLC, refer to 
each connection 
manual.

GT25-J71E71-100
GT27

GT25 *6

GT SoftGOT2000

- - GT25-WLAN
GT27 *4

GT25 *4*6

GS25 *4

• Wireless LAN access point
For the connectable wireless LAN access 
points and system devices, refer to the 
following Technical News.

➟List of Valid Devices Applicable for GOT2000 
Series and GOT SIMPLE Series (for 
Overseas) (GOT-A-0160)

- GT25-WLAN
GT27 *5

GT25 *5*6

GS25 *5

• Wireless LAN access point *7 - GT SoftGOT2000

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

PLC

Available cables differ depending 
on the connection type.

Wireless LAN 
access point

Connection cable

Connection cable, 
wireless LAN access point

Personal computer, 
tablet, 

or smartphone

Client GOT

GT SoftGOT2000
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• 10BASE-T: Up to 4 cascade-connected hubs (within 500 m)
• 100BASE-TX: Up to 2 cascade-connected hubs (within 205 m)

For the cascade connection between the switching hubs, there is no theoretical limit to the number of cascades.
For the limit, contact the switching hub manufacturer.

*4 Set [Operation Mode] to [Access Point] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*5 Set [Operation Mode] to [Station] in [Wireless LAN Setting] in the [GOT Setup] window.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
*6 Not available to GT2505-V and GT25HS-V.
*7 The usable wireless LAN access point varies with the personal computer used.

■2 Setting procedure

The setting procedure to use the GOT Mobile function depends on the model.
• GT27, GT25, and GS25

➟■3 Setting GT27, GT25, or GS25 as a server
• GT SoftGOT2000

➟■4 Setting GT SoftGOT2000 as a server

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Setting GT27, GT25, or GS25 as a server

Step 1 Set the GOT Ethernet interface.

➟5.4 Setting the GOT Ethernet Interface ([GOT Ethernet Setting])
Step 2 To use the GOT wireless LAN function, configure the wireless LAN connection setting.

➟5.3.12 Configuring the settings for a wireless LAN ([Wireless LAN Setting])
Step 3 Configure the GOT Mobile function setting.

Select [Common] → [GOT Mobile Setting] from the menu to display the [GOT Mobile Setting] window. In 
[Basic Setting], select [Use GOT Mobile function].
For the GOT Mobile function setting, refer to the following.

➟10.19.6 [GOT Mobile Setting] window
Step 4 Create a mobile screen.

Perform one of the following operations to display the [Screen Property] dialog.
• Select [Screen] → [New] → [Mobile Screen] from the menu.
• Double-click [New] under [Mobile Screen] in the tree in the [Screen] window.

In the displayed dialog, configure the setting and click the [OK] button.
➟10.19.7 Mobile screen properties

A created base screen or window screen can be copied to a mobile screen.
➟■5 Copying a base screen or window screen to a mobile screen

Step 5 A mobile screen is created and a screen editor appears in the work window.
Place figures and objects on the mobile screen.

➟6.5 Placing and Editing Figures and Objects
Step 6 If you have enabled the external access to the GOT public folder, create the public folder under the package 

folder.
Create the package folder in the data storage to be installed in the current drive of the GOT.
Store the public folder (folder name: userdata) in the package folder.

➟10.19.2 ■7 Public folder
After the public folder is created, install the data storage to the GOT.

Step 7 To use the file manager, refer to the following.

➟10.19.2 ■8 File manager
Step 8 To connect the GOT and clients without the operator name and password-based authentication, configure 

the setting in the [GOT Mobile Setting] window ([ANDON Setting]).

➟10.19.6 [GOT Mobile Setting] window
For the ANDON function, refer to the following.

➟10.19.4 ANDON function
Step 9 Connect the personal computer to the GOT, and write the project to the GOT.

➟4.3 Transferring the Data between the Personal Computer and the GOT
Step 10 Register the license number to the GOT.

For information on how to register the license number, refer to the following.
➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 Setting GT SoftGOT2000 as a server

Step 1 Enable Internet Information Services (IIS) and the required IIS components on a personal computer on 
which GT SoftGOT2000 runs.
For how to enable IIS, refer to the following.

➟(1) Enabling IIS
Step 2 Configure the GOT Mobile function setting.

Select [Common] → [GOT Mobile Setting] from the menu to display the [GOT Mobile Setting] window. In 
[Basic Setting], select [Use GOT Mobile function].
For the GOT Mobile function setting, refer to the following.

➟10.19.6 [GOT Mobile Setting] window
Step 3 Create a mobile screen.

Perform one of the following operations to display the [Screen Property] dialog.
• Select [Screen] → [New] → [Mobile Screen] from the menu.
• Double-click [New] under [Mobile Screen] in the tree in the [Screen] window.

In the displayed dialog, configure the setting and click the [OK] button.
➟10.19.7 Mobile screen properties

A created base screen or window screen can be copied to a mobile screen.
➟■5 Copying a base screen or window screen to a mobile screen

Step 4 A mobile screen is created and a screen editor appears in the work window.
Place figures and objects on the mobile screen.

➟6.5 Placing and Editing Figures and Objects
Step 5 If you have enabled the external access to the GOT public folder, create the public folder under the package 

folder.
Create the package folder in the virtual drive A.
Store the public folder (folder name: userdata) in the package folder.

➟10.19.2 ■7 Public folder
After the public folder is created, install the data storage to the GOT.

Step 6 To use the file manager, refer to the following.

➟10.19.2 ■8 File manager
Step 7 To connect GT SoftGOT2000 and the clients without the operator name and password-based 

authentication, configure the setting in the [GOT Mobile Setting] window ([ANDON Setting]).

➟10.19.6 [GOT Mobile Setting] window
For the ANDON function, refer to the following.

➟10.19.4 ANDON function
Step 8 Register the license number to the GT SoftGOT2000.

➟GOT Mobile Function License for GT SoftGOT2000 Registration Instructions
Step 9 Start GT SoftGOT2000 and open the created project.

➟GT SoftGOT2000 Version1 Operating Manual

(1) Enabling IIS
The following shows the steps to enable Internet Information Services (IIS) and the required IIS components.
This is an example of Windows 10.

Step 1 Select [Control Panel] from the Windows start menu.
The [Control Panel] window appears.

Step 2 Select [Programs] → [Turn Windows features on or off].
The [Windows Features] window appears.

Step 3 Select the following items and click the [OK] button.
• Internet Information Services
•  IIS Management Console
•  WebSocket Protocol
•  Internet Information Services Hostable Web Core

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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IIS and the required IIS components are enabled.
IIS starts automatically at the OS startup by default.
For operations such as to stop IIS, open the Windows start menu → [Administrative Tools] → [Internet Information 
Services (IIS) Manager] and perform the relevant operation in the [Actions] pane.

■5 Copying a base screen or window screen to a mobile screen

A created base screen or window screen can be copied to a mobile screen.
The following shows the procedure to copy a screen.

Step 1 In the [Screen] window, right-click on a base screen and window screen to be copied and select [Copy to 
Mobile Screen].

Step 2 In the [Copy to Mobile Screen] dialog, set the destination screen number and other items.

➟(2) [Copy to Mobile Screen] dialog
Step 3 Click the [Copy] button to copy the screen to the mobile screen.

(1) Specifications for copying a screen to a mobile screen
The following shows the specifications for copying a screen to a mobile screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Screen

Expanded screen Automatically resized according to the resolution of the model set in [GOT Type Setting].

Screen whose display is prohibited by 
setting the project security

Not available for copying.
When multiple screens are simultaneously copied, the screen numbers of the screens that 
are not copied are skipped.

Object

Go To Screen switch

When the screen after the switching is also copied, the screen number will be changed to 
the one specified for the copied screen.
The number will be retained when the screen after the switching is not copied.
When [Offset window screen No.] is selected, the copy destination screen number is the 
sum of the copy source screen number and the offset value.
If the sum is outside the range, the copy source screen number is retained.

Set overlay screen

When a copy source screen has a set overlay screen object, the called screen is also 
copied.
The screen number will be changed to the one specified for the copied screen (mobile 
screen).
The original screen number will be retained when the called screen is a display-prohibited 
screen.
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(2) [Copy to Mobile Screen] dialog

1) [Copy target Screen]
Displays the screen numbers to be copied to the mobile screen.
The screen numbers selected when [Copy to Mobile Screen] is pressed are displayed.

2) [Offset window screen No.]
The sum of the copy source screen number and the offset value is the copy destination window screen number.
Select this item to set the offset value to be added.
This function is helpful when using a copied screen as a window screen for mobile application.
In GOT, base screens (screen type [B]) and window screens (screen type [W]) are distinguishable. 
These screens for mobile application are both created as mobile screens [M] and thus indistinguishable.Use this 
function and set an offset value [1000], for example, is to be added. 
Then, you can use the screens with screen numbers in the 1000s as window screens.

3) [Destination No. of a base screen]
Specify a screen number of the copy destination screen (mobile screen) to which the base screen is copied.
The setting range is [0] to [32767].

4) [Destination No. of a window screen]
Specify a screen number of the copy destination screen (mobile screen) to which the window screen is copied.
The setting range is [0] to [32767].
When [Offset window screen No.] is selected, this item is grayed out.

5) [Specify the resolution of a mobile screen]
Set the screen size of the mobile screen.
For the setting details, refer to the following.

➟10.19.7 ■1 [Basic] tab

■6 Setting on the client
Enable JavaScript and Cookie in the browser.
The method to enable JavaScript or Cookie differs depending on the browser.
The setting items may also differ depending on the information device and the browser version.
For the setting method, refer to the following.
• For using Google Chrome (for Android or Windows)

➟Google Help website
• For using Safari (for iOS)

➟Apple Support website
• For using Microsoft Edge (for Windows)

➟Microsoft official website

1)

3)

2)

4)

5)
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■7 Usage

(1) Connecting a client
To connect a client to the GOT, enter the URL of the destination GOT on the address bar in the browser.

• GOT URL
"index.html" can be omitted from the URL.

The following shows the procedure for connecting a client using Google Chrome (for Android).
Step 1 Start Google Chrome.
Step 2 Touch the address bar, and enter the URL of the destination GOT with the software keyboard.
Step 3 In the authentication screen, enter an operator name and its password, and touch the [Login] button.

Step 4 If the client becomes authenticated to the GOT, an applicable mobile screen appears in the browser.

You can specify the mobile screen appearing after the client is authenticated to the GOT in the [GOT Mobile Setting] 
window. In [Screen Switching], select [Specify the No. of a screen to be displayed at the time of client connection] and 
specify a screen number.
If you do not specify the mobile screen, the smallest-numbered mobile screen appears.

➟10.19.6 ■4 [Screen Switching/Window]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

· When connecting a client to the standard HTTP port No. 80

http://192.168.1.18/index.html

· When connecting a client to a user-specified HTTP port 
  (Example: port No. 8080)

http://192.168.1.18 : 8080/index.html
port No.

GOT IP address

GOT IP address

Operator name

Password
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(a) URL parameters
The behavior of the client is customizable by appending specific parameters to the URL of the destination GOT.
The following shows available parameters.

To use a parameter, append "?<Parameter name>=<Setting value>" to the URL of the destination GOT.
Delimit parameters with single ampersands (&).
The used parameters must be different.
One-byte alphanumeric characters are usable for the parameters.
The parameters are case-sensitive.

Function Parameter 
name

Setting 
value

Behavior without the 
target parameter Remarks

Always fitting the mobile screen display 
on the width of the browser window autofit

true Same as for specifying 
"false" (The target 
function is disabled.)

-
false

Hiding the operation menu bar on the 
mobile screen hiddenmenu

true Same as for specifying 
"false" (The target 
function is disabled.)

When this function is enabled, zooming and 
scrolling the mobile screen display are not available.false

Specifying a client number to connect to 
the GOT clientno 1 to 5

A client number is 
automatically 
assigned.

The following client numbers cannot be specified.
• Client number that is higher than the set value of 

[Simultaneous Client Connection] in the [GOT 
Mobile Setting] window ([Basic Setting])

• Client number of a client being connected to the 
GOT

If you specify the client number set for [Target Client 
No.] in [ANDON Setting] of the [GOT Mobile Setting] 
window, also add the parameter for enabling the 
ANDON function (andon=true).

Enabling the ANDON function
(Connecting to the GOT without the 
operator name and password-based 
authentication)

andon

true

Same as for specifying 
"false" (The target 
function is disabled.)

When this function is enabled, the target client is not 
disconnected automatically even if no operation is 
performed on the client for a certain time.
To use the ANDON function, the settings must be 
configured on GT Designer3 and the utility as well.
For the details, refer to the following.

➟10.19.4 ■1 Settings required for the ANDON 
function

false

Specifying the screen number of the 
initial mobile screen appearing after the 
client connects to the GOT with 
authentication

initscreen 0 to 
32767

The corresponding 
setting made on GT 
Designer3 is applied.

To enable this function, turn on the Enable Initial 
Screen Specification with URL Parameter signal 
(GS1896.b0).
This parameter setting overrides the setting of 
[Specify the No. of a screen to be displayed at the 
time of client connection] in the [GOT Mobile 
Setting] window ([Screen Switching]).

Displaying the disconnect screen 
(client.html) when the client disconnects 
the GOT.

disconnectsc
reen

true

Same as for specifying 
"false" (The target 
function is disabled.)

When this function is enabled, the screen that 
appears at the disconnection changes.
• true: Displays the disconnect screen.
• false: Displays the connection authentication 

screen.
For details on the disconnect screen, refer to the 
following.

➟10.19.4 ■3 Displaying the disconnect screen

false

Example 1) When specifying client No. 3

　　  http://192.168.3.18/index.html?clientno=3

Example 2) When setting the following functions

　　　· Enabling the ANDON function

　　　· Always fitting the mobile screen display on the width of the browser window

　　　· Hiding the operation menu bar on the mobile screen

　　  http://192.168.3.18/index.html?andon=true&autofit=true&hiddenmenu=true

h t t p : / / 1 9 2 . 1 6 8 . 3 . 1 8 / i n d e x . h t m l ? <Parameter name 1>=<Setting value 1>&<Parameter name 2>=<Setting value 2>

URL of the destination GOT Parameter 1 Parameter 2
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(2) Operation menu bar on the mobile screen
The operation menu bar is displayed in the upper-left corner of a mobile screen to control the display.

1) Expand/collapse button
Expands or collapses the operation menu bar.
While the operation menu bar is expanded, you cannot touch the objects on the mobile screen.
However, you can scroll the screen by a swipe or flick operation on a tablet or smartphone.

2) Button to move the operation menu bar
Moves the operation menu bar from side to side.

3) [Fit Width] button
Adjusts the mobile screen display to fit on the width of the browser window.
While the [Fit Width] button is held down, the mobile screen display is fit on the width of the browser window 
automatically in the following timing.

• When the screen is switched
• When the width of the browser window is changed

4) [100%] button
Displays the mobile screen display at its original magnification (100%).

5) Disconnect button
Disconnects the client from the GOT.

6) Extended function button
Displays a pull-down menu.

• [File manager]
Displays the file manager screen where you can view the folders and files in the public folder, or perform 
manipulations on them such as copying.

➟10.19.2 ■8 File manager
• [Hard Copy]

Captures the current mobile screen in PNG format and outputs it to a new tab in the browser.
➟10.19.2 ■9 Hard copy function

7) Zoom slider
Zooms in or out the mobile screen display.
Move the slider control to the right to zoom in the display, and move the slider control to the left to zoom out the 
display.
The setting range is [10]% to [500]%.

1) 2) 3) 4) 5) 6) 7)
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(3) Zooming the mobile screen display
When the operation menu bar is expanded on the mobile screen, you can pinch in or out to zoom the screen display (10% 
to 500%).
The screen display is zoomed by moving fingers toward or away from each other.

(4) Disconnecting a client
If you perform any of the following operations, the client becomes disconnected from the GOT.

• Close an applicable browser.
• Perform a logout when the authentication method of the GOT Mobile function is set to the operator authentication.
• Touch the Disconnect button on the operation menu bar in the mobile screen.
• Turn on b0 of the client control device that is specified in [Client Information] of the [GOT Mobile Setting] window.
• Touch the [Disconnect] button on the [GOT Mobile information] screen in the utility.

The client becomes disconnected in the following timing as well.
• When a communication timeout occurs on the GOT
• When the GOT is turned off
• When the GOT enters the offline mode because of package data writing or others
• When no operation is performed on the client for a certain time

(When [Automatically disconnect clients with no operation] is selected in [Basic Setting] of [GOT Mobile Setting] 
window)
When the ANDON function is used, the client does not become disconnected.

• When the authentication method of the GOT Mobile function is set to the operator authentication, and the automatic 
logout is performed

• When the connection time exceeds 30 minutes without license registration
Once the client is disconnected from the GOT, the client is not automatically reconnected.
In such a case, reconnect the client to the GOT.

Line A 258

Client
(Tablet)

Reduce Enlarge

Line A 258
Line A 258

Line A
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10.19.4 ANDON function

The ANDON function enables a specific client to connect to the GOT without the operator name and password-based 
authentication. (The authentication screen does not appear.)
This function is usable for applications, such as an andon display. You can specify a set of a personal computer and a 
large-screen monitor as a client to display mobile screens.

For information on how to use the ANDON function, refer to the following.
➟■1 Settings required for the ANDON function

By configuring the above setting and the client side setting in combination, the target client can display a mobile screen 
upon its power-on.
For the details, refer to the following.

➟■2 Displaying a mobile screen on the client upon power-on
If you click the [OK] button in the confirmation dialog for disconnection while the ANDON function is enabled, the client 
does not become disconnected due to the automatic reconnection.
For how to display the disconnect screen without allowing a reconnection, refer to the following.

➟■3 Displaying the disconnect screen

■1 Settings required for the ANDON function

To use the ANDON function, configure all the following settings (1) to (3).

(1) Setting on GT Designer3
Step 1 Select [Common] → [GOT Mobile Setting] from the menu to display the [GOT Mobile Setting] window. In 

[ANDON Setting], select [Use ANDON function].
Step 2 Select a client number targeted for the ANDON function.

➟10.19.6 [GOT Mobile Setting] window

(2) Settings for the server (GOT)
In [ANDON connection] of the utility, set the IP address of a client targeted for the ANDON function.
For the setting, refer to the following.

➟GOT2000 Series User's Manual (Utility)

(3) URL parameter setting
When you enter the URL of the destination GOT on the address bar in the browser, add the parameter for enabling the 
ANDON function.

For the details of the URL parameters, refer to the following.
➟10.19.3 ■7 (1) (a) URL parameters

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Line
A 1254

B 348

A 1254

B 348

Server (GOT) Wireless LAN 
access point

Client 
(Personal computer 

and large-screen monitor)

Connection without 
the operator name 
and password-based 
authentication

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

h t t p : / / 1 9 2 . 1 6 8 . 3 . 1 8 / i n d e x . h t m l ? a n d o n = t r u e

URL of the destination GOT Parameter enabling 

the ANDON function
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■2 Displaying a mobile screen on the client upon power-on

A client can display a mobile screen upon power-on without specific operations, such as logging into the OS, starting a 
browser, and entering a URL on the address bar.
The following shows the setting method to achieve this behavior by using Windows 7 and Google Chrome (for Windows) 
as an example.

Step 1 Set the destination of a Google Chrome shortcut by specifying the URL of the destination GOT and the 
parameter for enabling the ANDON function.
Create a Google Chrome shortcut, and select [Properties] from the right-click context menu.
In the [Shortcut] tab of the [Google Chrome Properties] dialog, add the URL and parameter to [Target] as 
shown below.

Step 2 Configure the setting to open a browser in full screen mode.
In the [Shortcut] tab of the [Google Chrome Properties] dialog, add a one-byte space and "-kiosk" to [Target] 
as shown below.

Step 3 Configure the setting to open the browser automatically upon startup of Windows.
Place the Google Chrome shortcut set as above in the directory below.
[\Users\(User name)\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup]

Step 4 Configure the setting to log into Windows automatically upon power-on of the client.
On the Windows start menu, use [Search programs and files] to display the [Run] dialog.
Enter "netplwiz" in [Open] and click the [OK] button to display the [User Accounts] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

"…\chrome.exe" "http://192.168.3.18/index.html?andon=true"

URL of the destination GOT

One-byte space

Addition

Parameter enabling 

the ANDON function

……" "-kiosk"

One-byte space

Addition
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10
In the [Users] tab, select a user to log into Windows automatically, and clear [Users must enter a user name 
and password to use this computer].
Click the [OK] button to display the [Automatically Log On] dialog.

Enter the target user name and its password, and click the [OK] button.
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■3 Displaying the disconnect screen

When the ANDON function is used, clicking the OK button in the confirmation dialog for disconnection establishes an 
automatic reconnection without displaying the connection authentication screen.
Enable the URL parameter (disconnectscreen) to display the disconnect screen without allowing an automatic 
reconnection after clicking the OK button in the confirmation dialog for disconnection.

Clicking the [Reconnect] button establishes a reconnection.
When the ANDON function is not used, click the [Reconnect] button to display the connection authentication screen.
For the details of the URL parameters, refer to the following.

➟10.19.3 ■7 (1) (a) URL parameters

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.19.5 Precautions

■1 Precautions for drawing
(1) User area in the operation memory (RAM)

A portion of the user area is reserved for the GOT Mobile function, and another portion of the area is reserved for clients 
according to the setting of [Simultaneous Client Connection].
Consider the available space in the user area, and set [Simultaneous Client Connection].
The GOT reserves 2 MB space for each client.
For the available space in the GOT user area, refer to the following.

➟12.10.1 Data transferred to the GOT and capacity of the destination drive

(2) Project data size
If a client accesses the server (GOT) that has project data containing high-volume mobile screen data, a browser may 
abend and no mobile screens may be displayed depending on the specifications of the client.
In such a case, reducing the project data size by deleting unnecessary mobile screens or objects may prevent the 
symptom.

(3) Mobile screen size
To determine the mobile screen size, consider the screen resolution and OS of the information device, and the browser 
characteristics.
If you set the mobile screen size the same as the resolution of the information device, a portion of the screen may not be 
displayed depending on the location of the OS status bar, browser tabs, or other conditions.

(4) Mobile screen switching device
When you use multiple clients simultaneously, specify a GOT Mobile device as the mobile screen switching device.
If any device other than GOT Mobile devices is specified as the screen switching device, all clients display the same 
screen upon screen switching.

(5) Values of the GOT Mobile devices at the start of accessing the GOT
If you deselect [Initialize the devices (VGD, VGB) at the time of client connection] in the [GOT Mobile Setting] window 
([Device Allocation Setting]), the values of the GOT Mobile devices assigned to a client are not cleared automatically 
when the client starts accessing the GOT.
(The values stored before the access are retained.)
Configure the settings so that the values of the GOT mobile devices are cleared when a client starts accessing the GOT 
or becomes disconnected from the GOT.
Note that restarting the GOT clears the values of the GOT Mobile devices that are assigned to each client.

(6) Placing an object in the location of the operation menu bar on a mobile screen
When you place an object, make sure that the object and the operation menu bar do not overlap each other.
Otherwise, the object is hidden under the menu bar and you cannot touch the object.

(7) Data size of the project containing a BMP image
When the GOT Mobile function is enabled, if a BMP image is used in a mobile screen or is registered as a part, the image 
is automatically converted to the PNG format and saved as a new file.
(Even if you do not use the BMP image registered as a part in a mobile screen, the image is converted to the PNG format 
and saved as a new file.)
Since the project contains both the BMP image and the PNG image, the project size becomes larger.

(8) Using the GOT Mobile devices (VGB and VGD) for the GOT
Use the GOT Mobile devices (VGB and VGD) in the following settings only.
• Setting for an object on a mobile screen
• Setting in the [GOT Mobile Setting] window
• Setting in the [Alarm Popup Display(GOT Mobile Setting)] dialog
If you set the GOT Mobile devices for objects on screens other than mobile screens and for functions configured in the 
project, these objects and functions do not operate properly.

(9) Exclusive authorization control
To enable the exclusive authorization control, select all the setting items below.
• [Enable the exclusive control of operational authority] in the [GOT Mobile Setting] window ([Exclusive Control of 
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Operational Authority])
• [Target for exclusive control of operational authority] in the [Screen Property] dialog for each target mobile screen
If you select only one of the items, the exclusive authorization control is disabled in the project.

■2 Precautions for use
(1) Precautions for the license

When you incorporate the GOT into your product, if the GOT Mobile function is enabled in the GOT, make sure to register 
the license to the GOT.
If the license is unregistered, the GOT Mobile function is usable for 30 minutes only.
Upon the lapse of a cumulative amount of 30 minutes, the GOT forcibly disconnects the client.
The disconnection is performed even while you are operating the client. Therefore, the target controller may exhibit 
unintended behavior.

(2) [Back], [Forward], and [Refresh] buttons on the browser
While a mobile screen is being displayed, do not use the [Back] button, [Forward] button, and [Refresh] button on the 
browser.
Doing so disconnects the client from the GOT and returns you to the authentication screen.

(3) Zoom function of the browser
While a mobile screen is being displayed, do not use the zoom function of the browser.
Doing so may cause an unintended display, such as an enlarged or reduced operation menu bar.

(4) Files in the public folder
Each file in the public folder is accessible without authentication by specifying the URL of the file in the browser.
Once equipment is connected to the GOT by Ethernet, anyone can obtain the files in the public folder. Therefore, do not 
store your important data in the folder.

(5) Precautions for using the file manager
When the file manager is used for multiple tabs in the windows of the same browser, an error occurs.
Do not use the file manager for multiple tabs in the windows of the same browser.

You cannot move to the destination folder with the Return button in the file manager screen if you manipulate an open 
folder or file or its parent folders on the GOT.
In such a case, use the Directory button to display the directory tree, and select the folder to move to.

(6) GOT Mobile device information indicated by the system alarm
If a system alarm occurs in the process using GOT Mobile device data, the system alarm indicates the relevant GOT 
Mobile device as supplementary information.
The GOT internal device assigned to the GOT Mobile device is not indicated.

(7) Displaying the mobile screens in multiple languages
The display language of the mobile screens depends on the client OS.
To display the mobile screens in multiple languages, check that the client OS supports relevant languages.

(8) Long time use of the browser
If you use a browser for a long time, the connection with the GOT may be disconnected depending on the browser.
In such a case, perform authentication again to connect to the GOT.
If the hardware acceleration feature is used for the browser, disabling the feature may improve the situation.

(9) Forcibly turning off a touch switch if the communication is lost (momentary switch forced off)
If a touch switch is released on a client after the client loses communication with the GOT, the GOT does not recognize 
the release.
After a specified time (default: 3 seconds) elapses, the GOT forcibly turns off the touch switch.
Use the Time to Force Mobile Momentary Switch OFF device (GS1899) to set the time from when communication is lost 
until when the GOT forcibly turns off the touch switch.
For the details of the Time to Force Mobile Momentary Switch OFF device (GS1899), refer to the following.

➟12.1.3 ■6 (26) Time to Force Mobile Momentary Switch OFF (GS1899)
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(10)Corrective action when a touch switch (bit momentary) does not operate
When the browser is Google Chrome, a touch switch with bit momentary set may not operate.
In such a case, check if the setting for [Touch Events API] is [Automatic] in the browser.
The following shows how to check or change the setting.

• For Google Chrome version earlier than 79
1. Enter "Chrome://flags" in the Google Chrome address bar.
2. Enter "Touch Events API" in the search field [Search flags] at the top of the screen.
3. Check if the setting for [Touch Events API] is [Automatic].
If [Disabled] is set, change the setting to [Automatic].

• For Google Chrome version 79 or later
The setting for [Touch Events API] cannot be checked.
[Automatic] is set for [Touch Events API] when Google Chrome is run from the shortcut created in the following steps.
1. Create a shortcut to Google Chrome.
2. Select [Properties] from the context menu of the shortcut to open the window.
3. Append "--touch-events" to the path in [Target] and click the [OK] button.
Enter a one-byte space before "--touch-events".
(Description example for [Target])
"C:\Program Files (x86)\Google\Chrome\Application\chrome.exe" --touch-events

(11)Precautions when system alarm 621 occurs
The following shows how to act when system alarm 621 occurs.

• When port numbers are duplicated
Correct the port number to set different port numbers.
There must be three or more consecutive numbers between the port numbers specified.

• If GT SoftGOT2000 was abnormally terminated before starting the GOT Mobile function
Restart the personal computer.

(12)Display of the communication error message
If you turn off the GOT being accessed by a client, the browser of the client may not display a communication error 
message immediately.
Do not turn off the GOT while the client is being operated.

■3 Precautions for using the ANDON function
(1) Connection without the operator name and password-based authentication

If you only configure the settings required to use the ANDON function, anyone can access the GOT from the client using 
the ANDON function without an operator name and a password.
Take security measures for such a client, including limiting displayable screens.

(2) Login using the operator authentication
Even if [GOT Mobile Authentication Method] is set to [Operator] in [Authentication Setting] of the [GOT Mobile Setting] 
window, the operator authentication is not performed.
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)

10 - 359



10.19.6 [GOT Mobile Setting] window

Configure the GOT Mobile function setting.
Select [Common] → [GOT Mobile Setting] from the menu to display this window.
The display contents are changeable by selecting an item in the setting tree on the left of the window.

➟■1 [Basic Setting]
■2 [Authentication Setting]
■3 [Device Allocation Setting]
■4 [Screen Switching/Window]
■5 [Language Switching]
■6 [Client Information]
■7 [Security]
■8 [Alarm Popup Display]
■9 [Exclusive Control of Operational Authority]
■10 [ANDON Setting]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Basic Setting]

1) [Use GOT Mobile function]
Enables the GOT Mobile function.

2) [Simultaneous Client Connection]
Set the maximum number of clients connectable to the GOT simultaneously.
The GOT reserves 2 MB space of the user area in the operation memory (RAM) for each client.
The setting range depends on the GOT type.
GT27, GT25, and GS25: [1] to [5]
GT SoftGOT2000: [1] to [15]

3) [Use any port No. other than the standard port No. (80)]
Connects a client to the GOT through a port other than the standard port No. 80.
Select this item, and specify the port number.
The setting range is [1024] to [65535].

4) [Automatically disconnect clients with no operation]
Disconnects a client from the server (GOT) if no operation is performed on the client for a specified time period.
Select this item, and specify the time period until disconnection is performed.
The setting range is [1] minute to [60] minutes.

5) [Allow external access to GOT public folder]
Allows clients to access the files in the GOT public folder.
For the details of the public folder, refer to the following.

➟10.19.2 ■7 Public folder

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [Authentication Setting]

For the details of the authentication, refer to the following.
➟10.19.2 ■5 Authentication

1) [GOT Mobile Authentication Method]
Select an authentication method for connecting a client to the GOT.
The following shows the items to be selected.

• [GOT Mobile exclusive]
• [Operator]

2) [GOT Environmental Setting-Security] button
Displays the [Environmental Setting] window ([Security]).
For the settings in the [Environmental Setting] window ([Security]), refer to the following.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])
3) [Use an administrative operator]

Set an administrator operator account for authentication.
When authenticated with the administrative operator account, the client can obtain the authorization of the GOT 
network interaction function.
This item is settable when [GOT Mobile Authentication Method] is set to [GOT Mobile exclusive].
Select this item, and set [Operator] and [Password].
Specify the operator name and password with one-byte upper- and lowercase alphabets and numbers, one-byte 
spaces, and the symbols below within 32 characters.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { ¦ } ̃
Note that the operator name or password cannot end in a one-byte space.

4) [Use a guest operator]
Set a guest operator account for authentication.
When authenticated with the guest operator account, the client cannot obtain the authorization of the GOT network 
interaction function.
This item is settable when [GOT Mobile Authentication Method] is set to [GOT Mobile exclusive].
Select this item, and set [Operator] and [Password].
Specify the operator name and password with one-byte upper- and lowercase alphabets and numbers, one-byte 
spaces, and the symbols below within 32 characters.
! “ # $ % & ‘ ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { ¦ } ̃
Note that the operator name or password cannot end in a one-byte space.

5) [Connectable Security Level]
Set the security level of the operator allowed to access the GOT.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10
This item is settable when [GOT Mobile Authentication Method] is set to [Operator].
The setting range is [0] to [15].

■3 [Device Allocation Setting]

For the details of the GOT Mobile devices, refer to the following.
➟10.19.2 ■4 GOT Mobile device (VGB and VGD)

1) [Device (VGD, VGB) Allocation]
Set GOT internal devices to be assigned to the GOT Mobile devices (VGD and VGB).
The number of GOT internal devices (GD and GB) to be assigned is obtained by the following formula: [Points] × 
[Simultaneous Client Connection].

2) [Device (VGD, VGB) Allocation Table]
Shows the correspondence between the GOT Mobile devices and the assigned GOT internal devices by client 
number.

Item Description

[Word Device (GD)]

[Points]
Set the number of GOT internal devices (GD) to be assigned for one client.
The value is settable in 2-point units.
The setting range is [2] to [32768].

[First Device]

Set the first GOT internal device (GD) to be assigned for client 1.
The consecutive devices starting from [First Device] are assigned for clients. The total number 
of assigned devices is obtained by the following formula: [Points] × [Simultaneous Client 
Connection].
The setting range is [GD0] to [GD65535].

[Bit Device (GB)]

[Points]
Set the number of GOT internal devices (GB) to be assigned for one client.
The value is settable in 32-point units.
The setting range is [32] to [32768].

[First Device]

Set the first GOT internal device (GB) to be assigned for client 1.
The consecutive devices starting from [First Device] are assigned for clients. The total number 
of assigned devices is obtained by the following formula: [Points] × [Simultaneous Client 
Connection].
The setting range is [GB0] to [GB65520].

Item Description

[Simultaneous Client Connection] Maximum number of clients connectable to the GOT simultaneously
The value set in [Basic Setting] is displayed.

[Valid Device (VGD, VGB)] Setting range of GOT Mobile devices usable in clients

[Client1] to [Client15] GOT internal devices that are assigned for each client

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Initialize the devices (VGD, VGB) at the time of client connection]
Clears the values of the GOT Mobile devices assigned to a client when the client connects to the GOT.

■4 [Screen Switching/Window]

For the details of screen switching on a client, refer to the following.
➟10.19.2 ■2 (1) (b) Screen switching

1) [Screen Switching Device]
Set the screen switching device for clients.
You can specify a word device or word-specified bit device.

2) Settings of overlap windows 1 and 2 and superimpose windows 1 and 2
Set whether to use overlap windows 1 and 2, superimpose windows 1 and 2, screen switching devices, display 
methods, and others.
For details, refer to the following.

➟5.2.1 ■5 [Screen Switching/Window]
3) [Screen Switching Device Data Type]

Select the data type of the screen switching device for clients.
The following shows the items to be selected.

• [BIN]: Signed 16-bit binary or unsigned 16-bit binary
• [BCD]: 16-bit binary coded decimal

4) [Specify the No. of a screen to be displayed at the time of client connection]
Set the screen number of the mobile screen to be displayed immediately after the client becomes authenticated to 
the GOT.
The setting range varies depending on the setting of [Screen Switching Device Data Type].

• For [BIN]: [0] to [32767]
• For [BCN]: [0] to [9999]

5) [Screen No. of the mobile screen to hide windows]
Set the screen number of a mobile screen. Then, the overlap windows and superimpose windows displayed on the 
screen are hidden.
When the set number is stored in the screen switching device, the corresponding window is hidden.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■5 [Language Switching]

For the details of language switching on the mobile screen, refer to the following.
➟10.19.2 ■2 (1) (c) Language switching

1) [Language Switching Device]
Set the language switching device for clients.
You can specify a word device or word-specified bit device.

2) [GOT Environmental Setting-Language Switching] button
Displays the [Environmental Setting] window ([Language Switching]).
For language switching on the mobile screen, the GOT environmental settings are applied except the setting of 
[Language Switching Device].
For the settings in the [Environmental Setting] window ([Language Switching]), refer to the following.

➟5.2.2 ■4 [Language Switching]
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■6 [Client Information]

Set the devices to notify the information on the client being connected or to control the state of the client.

1) [Client No. Notification Device]
Set a device to store the client number of the client being connected.
Select this item, and set the device.
You can specify a GOT Mobile device (VGD) only.
The data type of the device is unsigned 16-bit binary.

2) [Client IP Address Notification Device (2 Points)]
Set a device to store the IP address of the client.
Select this item, and set the device.
You can specify a GOT Mobile device (VGD) only.
Two consecutive word devices are reserved, starting from the specified device.
The data type of the device is unsigned 32-bit binary.
The IP address is stored as shown below.

3) [Client Control Device]
Set a device to control the state of the client being connected.
Select this item, and set the device.
Turning on b0 of the set device disconnects the client from the GOT.
You can specify a GOT Mobile device (VGD) only.
The data type of the device is unsigned 16-bit binary.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

Start device

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Second device

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

IP address: C0. A8. 03. 12 (Hexadecimal)

Example) When the IP address is 192.168.3.18 (decimal)
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■7 [Security]

The setting items differ according to the authentication method of the screen security.
For the details of the mobile screen security authentication, refer to the following.

➟10.19.2 ■2 (3) (a) Screen security (level authentication and operator authentication)

(1) For the level authentication

1) [Authentication Method]
Displays the security authentication method selected for [Authentication Method] in the [Environmental Setting] 
window ([Security]).

2) [GOT Environmental Setting-Security] button
Displays the [Environmental Setting] window ([Security]).
The security level password is common to the clients and the GOT.
Change the authentication method and security level password for the GOT as necessary.
For details, refer to the following.

➟5.2.6 ■3 [Security] ([Screen Security] tab)
3) [External Control Security Level Device]

Set a device to store the security level of a client.
You can specify a word device or word-specified bit device.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) For the operator authentication

1) [Authentication Method]
Displays the security authentication method selected for [Authentication Method] in the [Environmental Setting] 
window ([Security]).

2) [GOT Environmental Setting-Security] button
Displays the [Environmental Setting] window ([Security]).
Change the authentication method for the GOT as necessary.
For details, refer to the following.

➟5.2.6 ■3 [Security] ([Screen Security] tab)
3) [Store operator ID to the device]

Set a device to store the ID number of the operator who is logged in from a client (Operator ID External Notification 
device).
You can specify a GOT Mobile device (VGD) only.
The specified device stores 0 when the operator logs out.

4) [Store operator name to the device (8 Points)]
Set a device to store the name of the operator who is logged in from a client (Operator Name External Notification 
device).
You can specify a GOT Mobile device (VGD) only.
Eight consecutive word devices are reserved, starting from the specified device.
If the operator name contains less than 16 characters, blank devices store 0.
All the devices store 0 when the operator logs out.

5) [Store the operator security level to the device]
Set a device to store the security level of the operator who is logged in from a client (Operator Level External 
Notification device).
You can specify a GOT Mobile device (VGD) only.
The specified device stores 0 when the operator logs out.

6) [Externally control the security level]
Set a device to externally control the operator authentication on a client (Operator Authentication External Control 
device).
You can specify a word device or word-specified bit device.
For the details of the security level control from an external device, refer to the following.

➟5.2.7 ■1 (8) Security level control from an external device

1)

3)
4)

2)

5)

9)

8)

7)

6)

10)
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7) [Enable screen setting for logout]
Set a screen to be displayed at logout.
When using an overlap window or superimpose window, set a screen switching device in [Screen Switching/
Window] in the [GOT Mobile Setting] window.
Click the [Browse] button to display the [Screen Image List] dialog.

When [GOT Mobile Authentication Method] is set to [Operator] in [Authentication Setting], the GOT disconnects the 
client at logout, and therefore the specified screen does not appear.

➟■2 [Authentication Setting]
8) [Screen Switching] button

Displays the setting screen for the screen switching devices.
➟■4 [Screen Switching/Window]

9) [Display log-in completion notification]
Displays a login completion notification dialog upon login.

10) [Auto Close Setting]
Closes the login completion notification dialog automatically.
Select this item, and specify the time period from when the login completion notification dialog appears until it 
closes.
The setting range is [1] second to [60] seconds.

• Screen image list
Displays mobile screen images.
Select a screen to be displayed at logout.

• Jump
Specify a screen number and click the [Jump] 
button to select the screen in the screen image list.

Screen image list

Jump
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■8 [Alarm Popup Display]

For the details of the alarm popup display on mobile screens, refer to the following.
➟10.19.2 ■2 (d) Alarm popup display

1) [Use alarm popup display]
Uses the alarm popup display on mobile screens.

2) [Alarm Popup Display Setting] button
Displays the following dialog to configure the alarm popup display setting for mobile screens.

To utilize the alarm popup display setting for the GOT, click the [Yes] button to display the [Alarm Popup 
Display(GOT Mobile Setting)] dialog.
To not to utilize the alarm popup display setting for the GOT, click the [No] button to display the [Alarm Popup 
Display(GOT Mobile Setting)] dialog.

➟9.1.4 Enabling the popup display for when an alarm occurs
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■9 [Exclusive Control of Operational Authority]

For the details of the GOT network interaction function, refer to the following.
➟5.6 Setting the Interaction Function for Equipment on Ethernet ([GOT Network Interaction])

1) [Enable the exclusive control of operational authority]
Enables the authorization control of the GOT network interaction function in the GOT Mobile function.
This item is settable only when the GOT network interaction function is enabled.
To enable the authorization control for a screen, select [Target for exclusive control of operational authority] in the 
[Basic] tab in the [Screen Property] dialog.

➟10.19.7 ■1 [Basic] tab
2) [GOT Network Interaction] button

Displays the [GOT Network Interaction] dialog.
For the settings in the [GOT Network Interaction] dialog, refer to the following.

➟5.6.4 [GOT Network Interaction] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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3) [Specify the home screen No.]
Set a mobile screen to be displayed by the home screen button on the popup display of the GOT network interaction 
function.
Select this item, and specify the screen number of the mobile screen.
Make sure to disable the authorization control in the mobile screen set as the home screen.
For the details of the home screen in the GOT network interaction function, refer to the following.

➟5.6.2 ■3 Operation on target equipment
Click the [Browse] button to select a mobile screen in thumbnail view in the [Screen Image List] dialog.

4) [Operational Authority Status Control Device]
Set a device to control the authorization status.
Select this item, and set the device.
You can specify a GOT Mobile device (VGD) or word-specified GOT Mobile device (VGB).
For the details of the Operational Authority Status Control device, refer to the following.

➟10.19.2 ■6 (2) Operational Authority Status Control device
5) [Operational Authority Status Notification Device]

Set a device to notify the authorization status.
Select this item, and set the device.
You can specify a GOT Mobile device (VGD) or word-specified GOT Mobile device (VGB).
For the details of the Operational Authority Status Notification device, refer to the following.

➟10.19.2 ■6 (1) Operational Authority Status Notification device
6) [Setting of [Target for exclusive control of operational authority] of mobile screens]

Enables or disables the setting of [Target for exclusive control of operational authority] in all mobile screens at once.
For the mobile screen setting, refer to the following.

➟10.19.7 Mobile screen properties

• [Screen Type]
Displays the screen type.

• Screen image list
Displays mobile screen images.
Select a destination screen.

• Jump
Specify a screen number and click the [Jump] 
button to select the screen in the screen image list.

Screen image list

Jump
10 - 372 10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)



FU
N

C
TI

O
N

S 
U

SE
D

 W
IT

H
 P

ER
IP

H
ER

A
L 

D
EV

IC
ES

10
■10 [ANDON Setting]

For the details of the ANDON function, refer to the following.
➟10.19.4 ANDON function

1) [Use ANDON function]
Enables connection between the GOT and clients without the operator name and password-based authentication.

2) [Target Client No.]
Select the target client number of the ANDON function.
The number of settable clients depends on the model.
The selected client connects to the GOT without the operator name and password-based authentication. 
Connection using the GOT Mobile exclusive authentication or the operator authentication is not applicable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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10.19.7 Mobile screen properties

Set the properties of a mobile screen.
To display the properties, perform one of the following operations.
When creating a mobile screen
• Select [Screen] → [New] → [Mobile Screen] from the menu.
• Double-click [New] under [Mobile Screen] in the tree in the [Screen] window.
When editing an existing mobile screen
• Right-click a mobile screen, and select [Screen Property].
• Right-click a mobile screen in the tree in the [Screen] window, and select [Screen Property].

➟■1 [Basic] tab

■1 [Basic] tab

1) [Screen No.]
Set a screen number.
The setting range is [0] to [32767].
If you display the [Screen Property] dialog selecting multiple screens, this value cannot be changed.

2) [Screen Name]
Set the title of the screen.
Up to 32 characters can be set.

3) [Screen Type]
Displays the screen type.

4) [Detailed Description]
Set the explanation for the screen.
Up to 512 characters can be set.
A line feed is counted as two characters.

5) [Security]
Set the security level.
The setting range is [0] to [15].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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If you do not use the security function of the GOT, select [0].
➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

6) [Screen Size]
Set the screen size.

7) [Individually set the screen design]
Enables the individual screen design (including the background color), instead of the design selected in the [Screen 
Design] dialog.

8) [Background Color]

Select a background color.
For the color setting, refer to the following.

➟6.4.2 Color settings

Select a background color, pattern, and pattern color for the screen.
The pattern is displayed on the colored background.

Item Description

[Resolution]

Select the resolution of the mobile screen.
The values of [X] and [Y] are automatically specified according to the selection for [Resolution].
The following shows the items to be selected.

[VGA (640x480) [4:3]] [SVGA (800x600) [4:3]] [XGA (1024x768) [4:3]] [QXGA (2048x1536) [4:3]]

[WXGA (1280x800) [16:10]] [HD (1280x720) [16:9]] [FWXGA (1366x768) [16:9]] [Full HD (1920x1080) [16:9]]

[WUXGA (1920x1200) 
[16:10]]

[iPhone 4] [iPhone 5] [iPhone 5c] [iPhone 5s]

[iPhone 6] [iPhone 6 Plus] [iPhone 6s] [iPhone 6s Plus]

[iPhone 7] [iPhone 7 Plus] [iPhone 8] [iPhone 8 Plus]

[iPhone X] [iPhone XR] [iPhone XS] [iPhone XS Max]

[iPhone 11] [iPhone 11 Pro] [iPhone 11 Pro Max] [iPhone 12 mini]

[iPhone 12] [iPhone 12 Pro] [iPhone 12 Pro Max] [iPhone SE]

[iPhone SE (2nd 
generation)]

[iPad (5th generation)] [iPad (6th generation)] [iPad (7th generation)] [iPad (8th generation)]

[iPad Air (1st generation)] [iPad Air 2] [iPad Air (3rd generation)] [iPad Air (4th generation)]

[iPad mini 2] [iPad mini 3] [iPad mini 4] [iPad mini (5th generation)]

[iPad Pro 9.7-inch] [iPad Pro 10.5-inch] [iPad Pro 11-inch (1st 
generation)]

[iPad Pro 11-inch (2nd 
generation)]

[iPad Pro 11-inch (3rd 
generation)]

[iPad Pro 12.9-inch (1st 
generation)]

[iPad Pro 12.9-inch (2nd 
generation)]

[iPad Pro 12.9-inch (3rd 
generation)]

[iPad Pro 12.9-inch (4th 
generation)]

[iPad Pro 12.9-inch (5th 
generation)]

[Custom]

The above resolutions are approximate and should be used for reference.
Adjust the resolution according to the information device and browser to be used.

[X]
Screen width
If you change a specified value, the selection for [Resolution] is changed to [Custom].
The setting range is [16] to [3000].

[Y]
Screen height
If you change a specified value, the selection for [Resolution] is changed to [Custom].
The setting range is [2] to [3000].

[Switch X and Y] button
Interchanges the values of [X] and [Y].
If you click this button, the selection for [Resolution] is changed to [Custom].

GOT Graphic Ver.2

GOT Graphic Ver.1
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9) [Pop up alarms]
An alarm pops up when an alarm occurs.

Configure the following settings additionally.
• User alarm settings or system alarm settings
➟9.1.2 ■7 [User Alarm Observation] dialog

9.1.3 ■5 [System Alarm Observation] dialog
• Alarm popup display settings
➟9.1.4 ■4 [Alarm Popup Display] dialog

10) [Target for exclusive control of operational authority]
Enables the authorization control in the screen being edited.

➟10.19.2 ■6 Authorization control
To enable the authorization control throughout the project, select [Enable the exclusive control of operational 
authority] in the [GOT Mobile Setting] window ([Exclusive Control of Operational Authority]).

➟10.19.6 ■9 [Exclusive Control of Operational Authority]

Item Description

[Display Position]

Select the position to display an alarm to be popped up.
The following shows the items to be selected.
• [Top]
• [Center]
• [Bottom]

Pattern + Pattern color

Background color

Example)

Pattern
Pattern color :

:

Background color :
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10.19.8 Relevant settings

Set the relevant settings other than the specific settings for the GOT Mobile function as required.
The following shows the functions that are available by the relevant settings.

➟12.1.3 GOT special register (GS)

■1 GOT internal device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Storing the number of clients connected to the GOT
(Write device)

GS1400

Turned on when a client is connect to the GOT
(Write device)

GS1401.b1 to .b15

Specifying a security level with which folder and file manipulations are allowed on the file manager screen
(Read device)

GS1892

Setting whether to use the URL parameter (initscreen)
(Read device)

GS1896.b0

Enabling folder and file manipulations on the file manager screen
(Read device)

GS1896.b1

Setting the time from when communication is lost between the GOT and a client until when the GOT forcibly turns off 
the touch switch being touched on the client
(Read device)

GS1899
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10.19.9 Troubleshooting

If you have any trouble with the GOT Mobile function, check the operating environment first.
➟10.19.2 ■1 Operating environment

■1 Troubleshooting for clients
The following shows the troubleshooting for clients.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Symptom Details of error and cause Corrective action

Although a URL is specified, a communication 
error occurs and no screen appears.

The specified URL is incorrect.
Enter the correct URL.
➟10.19.3 ■7 (1) Connecting a client

The setting for connection to the server 
(GOT) is configured incorrectly.

Check that the system is configured correctly.
➟10.19.3 ■1 System configuration
If the system is configured correctly, check that the 
connection setting on the client and the following 
settings on GT Designer3 are configured correctly.
• [GOT Standard Ethernet Setting] in the [Controller 

Setting] window
• [Wireless LAN] in the [I/F Communication Setting] 

window
• [Destination Access Point Setting] or [Access Point 

Setting] in the [GOT Setup] window ([Wireless LAN 
Setting])

➟5.5.1 Setting channels
5.7.3 [I/F Communication Setting] dialog
5.3.12 Configuring the settings for a wireless LAN 

([Wireless LAN Setting])

The system application (extended function) 
for the GOT Mobile function is not installed 
on the GOT.

Write the package data that contains the system 
application (extended function) for the GOT Mobile 
function to the GOT.
➟4. COMMUNICATING WITH GOT

After the authentication, the client stays at a 
black screen and no mobile screen appears.

The antivirus software causes the mobile 
screen not to appear.

Set any number other than 80 or 8080 for the HTTP 
port No. for GOT Mobile.
➟10.19.6 ■1 [Basic Setting]
If no mobile screen appears even after you change 
the port number, disable the antivirus software.

No mobile screen appears due to 
unintended browser refresh at switching 
between tabs or by other actions.

Close all browser tabs, restart the browser, and 
connect the server (GOT) again.

Response speed is low.

When you operate a mobile screen or an 
object on the mobile screen, the response 
speed or display refresh rate is low 
depending on the specifications of the 
client.

Reduce the number of objects or graph points on the 
mobile screen.
The situation may improve.

The client is unintentionally disconnected from 
the GOT.

Browser tabs may be switched or another 
application may be operated during 
communications with the server (GOT).

Connect the client to the server (GOT) again.
Close unnecessary browser tabs or exit applications 
other than the browser.
The situation may improve.

A mobile screen is unintentionally enlarged. The screen may be enlarged when 
displayed for the first time.

Adjust the screen display to fit on the width of the 
browser window by using the [Fit Width] button on the 
mobile screen operation menu bar. 
Alternatively, preset the mobile screen size 
appropriate to the enlarged view.

A message saying [License unregistration.] 
appears on the mobile screen.

The license of the GOT Mobile function is 
unregistered to the GOT.

Register the license of the GOT Mobile function to the 
GOT.
➟GOT2000 Series User's Manual (Utility)
GOT Mobile Function License for GT SoftGOT2000 

Registration Instructions
The client is disconnected from the GOT after a 
lapse of 30 minutes.

After displaying a mobile screen, the client 
becomes disconnected after a certain period of 
time.

The client is communicating with the server 
(GOT) using USB LAN conversion with 
[USB selective suspend setting] set to 
[Enable] in Windows.

Set [USB selective suspend setting] in Windows to 
[Disable] in the following procedure.
1. In Windows, select [Control Panel] - [Power 
Options].
2. Click [Change plan settings] for the current power 
plan.
3. Click [Advanced settings].
4. Select [USB settings] - [USB selective suspend 
setting] - [Disabled] and click the [OK] button.
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■2 Error messages on clients
(1) Errors before authentication

(2) Errors at authentication

Error message Cause Corrective action

Unsupported browser.
Check the operating environment.

The browser does not support the following 
items.
• HTML5
• CSS3
• JavaScript
• WebSocket Protocol(RFC 6455)

Use a browser that meets operating environment 
conditions.
➟10.19.2 ■1 (3) Client operating environment

JavaScript is disabled.
Enable JavaScript and connect again. JavaScript is disabled in the browser.

Enable JavaScript in the browser.
➟10.19.3 ■6 ■6 Setting on the client

Cookie is disabled.
Enable Cookie and connect again. Cookie is disabled in the browser.

Enable Cookie in the browser.
➟10.19.3 ■6 ■6 Setting on the client

Error message Cause Corrective action

The operator name or password is incorrect.
Please check the operator name or password 
and execute again.

An incorrect operator name or password 
has been entered at authentication. Check the entered operator name and password.

The operator information is being edited in the 
destination device.
Please wait for a while and connect again.

The operator authentication cannot be 
performed because the operator 
management information file is being edited 
on the server (GOT).

Perform the operator authentication again after the 
edit is completed.

Exceeding the maximum number of connections 
and the connection cannot be made.
Please wait for a while and try again.

The connection failed because the number 
of clients has exceeded the maximum 
number of simultaneously connectable 
clients.
➟10.19.6 ■1 [Basic Setting]

• Reconnect to the GOT after any other client 
becomes disconnected from the GOT.

• Check that no operator who has used the GOT 
Mobile function maintains a logged-in state.

Destination does not respond.
Check the communication environment and 
connect again.

The client cannot communicate with the 
server (GOT) due to a radio disturbance or 
a failure in the information device.

Check that the communication environment 
between the server (GOT) and client is established 
properly.

The operator is locked or disabled and cannot 
log in. 
Please check with the administrator.

A locked operator account due to incorrect 
login attempts or a disabled operator 
account is used.

Ask your system administrator to unlock or enable 
the operator account.

Parameters specified in the URL is wrong.
Please check parameters.

An incorrect URL parameter has been 
entered on the address bar in the browser.

Check the entered URL parameter.
➟10.19.3 ■7 (1) (a) URL parameters

Parameters specified in the URL is invalid.
Please check the connection destination setting.

The URL parameter setting is inconsistent 
with the settings on GT Designer3 or the 
GOT.

Check that the settings are configured correctly on 
GT Designer3 and the GOT.
➟10.19.3 ■7 (1) (a) URL parameters

The client No. specified in the URL is in use and 
cannot be accessed.
Please wait for a while and try again.

The connection failed because any other 
client is connecting to the GOT by using the 
specified client number.

Reconnect to the GOT after the client using the 
specified client number becomes disconnected 
from the GOT.
➟10.19.3 ■7 (1) (a) URL parameters

The operator does not meet the connection 
conditions and cannot log in.
Please check with the administrator.

The connection with the operator 
authentication failed because the security 
level of the operator is insufficient.

Ask your system administrator to check the security 
level setting.

Your password has expired and cannot log in.
Please change the password on the connection 
destination.

The connection with the operator 
authentication failed because the entered 
password has expired.

Change the password on the GOT.
10. FUNCTIONS USED WITH PERIPHERAL DEVICES
10.19 Monitoring a Controller from Tablets or Other Clients (GOT Mobile Function)

10 - 379



(3) Errors in the process of monitoring

Error message Cause Corrective action

Trial time has expired.
Connection disconnected.

The trial connection time has elapsed, and 
the client became disconnected from the 
server (GOT). This is because the license 
number of the GOT Mobile function is 
unregistered to the server (GOT).

Register the license of the GOT Mobile function to 
the GOT.
➟GOT2000 Series User's Manual (Utility)
GOT Mobile Function License for GT SoftGOT2000 

Registration Instructions

Connection with destination is disconnected.
Check the communication path.

Communication between the server (GOT) 
and client has been lost.

Connect the client to the server (GOT) again.
If connection cannot be established, check that the 
communication environment between the server 
(GOT) and client is established properly.

Destination has changed to a offline mode.
The connection has been terminated.

The server (GOT) disconnected the client, 
because the server (GOT) entered the 
offline mode because of package data 
writing or others.

Connect the client to the server (GOT) again.

Mobile screen was not operated for a set period 
of time.
Connection terminated.

The server (GOT) disconnected the client, 
because the automatic logout time elapsed.
➟10.19.6 ■1 [Basic Setting]

Connect the client to the server (GOT) again.

The operator information is being edited in the 
destination device.
Please wait for a while and login and change 
password again.

You cannot log in using the operator 
authentication from the client. If you are 
already logged in, you cannot change your 
operator account password on the client. 
These are because the operator 
management information file is being edited 
on the server (GOT).

Perform the operator authentication again or 
change the password after the edit is completed.

You have been logged out.
The connection has been terminated.

When you are logged in using the operator 
authentication, a logout is performed on the 
client.

Connect the client to the server (GOT) again.

Authentication method is set to the operator 
authentication. 
Operators cannot be changed.

The operator switching was denied 
because you are logged in using the 
operator authentication.

Log out of the operator account in use, and log in 
with another operator account.
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11.1 Searching for Utilizable Data (Utilize Data)

When you create a project or screen, search a sample or existing project for utilizable data based on the specified search 
criteria, such as a keyword.
You can find utilizable data efficiently without the knowledge of the settings in the sample or existing project.

➟11.1.1 Specifications for the utilize data
11.1.2 How to use the utilize data
11.1.3 Precautions
11.1.4 [Utilize Data (Project)] dialog and [Search] dialog
11.1.5 [Utilize Data (Screen)] window
11.1.6 [Utilize] dialog
11.1.7 [Detail Screen Setting] dialog
11.1.8 Registering the add-on license

If you know the settings in a project to be utilized, you can specify data to be utilized from the project directly.
➟11.4 Utilizing Other Project Data

11.1.1 Specifications for the utilize data

■1 File formats of utilizable projects
The following shows the file formats of utilizable projects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Project format

GOT2000 Series

• Workspace format
• Single file format (*.GTX, *.GTXS)
If a project is saved when [Include projects for the function of Utilize Data] is deselected in the [Project 
information] dialog, the project is not utilizable.
11 - 2 11. USEFUL FUNCTIONS
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11.1.2 How to use the utilize data

➟■1 Utilizing a project
■2 Utilizing a screen

■1 Utilizing a project

Step 1 Select [Project] → [Utilize Data] from the menu to display the [Utilize Data (Project)] dialog.
Step 2 Set the search criteria and click the [Search] button to list the search results.

➟11.1.4 [Utilize Data (Project)] dialog and [Search] dialog

Step 3 Select the utilizable project and click the [OK] button to create the project to be utilized.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list
11. USEFUL FUNCTIONS
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■2 Utilizing a screen

Step 1 Display the [Utilize Data (Screen)] window combined with GT Designer3.
(The [Utilize Data (Screen)] window combined with GT Designer3 by default.)
When the window is not displayed, operating any one of the following displays it.

• Select [Screen] → [Utilize Data] from the menu.
• Select [View] → [Docking Window] → [Utilize Data (Screen)] from the menu.

Step 2 Set the search criteria and click the [Search] button to list the search results.

➟11.1.5 [Utilize Data (Screen)] window

Step 3 Select the checkbox for a screen to be utilized and perform one of the following operations to display the 
[Utilize] dialog.

➟11.1.6 [Utilize] dialog
• Click the [Utilize] button.
• Drag a target screen to the work window from the search result list.

Step 4 Set a screen number to be assigned in the destination project, and click the [Next] button.

➟11.1.6 ■1 [Target Screen Setting]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list
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Step 5 Set whether to utilize the settings related to the target screen, assign the setting numbers, and click the 
[Next] button.

➟11.1.6 ■2 [Related Setting Edit]

Step 6 If labels (GT Designer3) are used in the target screen and the settings related to the screen, set whether to 
utilize the relevant label groups, assign label group numbers, and click the [Next] button.

➟11.1.6 ■2 [Related Setting Edit]
11. USEFUL FUNCTIONS
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Step 7 Select a channel for each controller type to be used in the destination project, and click the [Next] button.

➟11.1.6 ■3 [Controller Setting]
If multiple channels are used in the source project, this step is repeated for each additional channel.

Step 8 If necessary, change the unit number and axis number specified for an applicable device used in the target 
screen, and click the [Next] button.

➟11.1.6 ■4 [Unit No./Axis No. Setting]
11 - 6 11. USEFUL FUNCTIONS
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Step 9 Confirm the displayed contents and click the [Finish] button to execute the screen utilization.

➟11.1.6 ■5 [Confirmation]
11. USEFUL FUNCTIONS
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11.1.3 Precautions

■1 Utilizing the project protected with a security key
When the project to be searched is protected with a security key, the security key authentication is performed.
If the authentication fails, the project name is not displayed in the search result list.

➟2.12 Protecting a Project with a Security Key

■2 Utilizing the project protected with the project security
(1) User authentication for the project

When the project security is set in the search target project, user authentication is conducted.
➟2.13 Protecting a Project by Registering Users

When the project security is set in the project that is being edited, the search target project that can be authenticated is 
automatically authenticated by the logged-in username and password.

(2) Whether utilizing data by access privilege is available or not
(a) Utilizing the project

When the display of the entire project or a part of the screen is prohibited, the project cannot be utilized.
When the display of the entire project is prohibited, the project is not displayed on the [Utilize Data (Screen)] dialog.
When the screen where the display is prohibited exists, the preview is the dummy screen.

(b) Utilizing data of a screen
The screen where the display is prohibited cannot be utilized.
The preview of the screen where the display is prohibited is a dummy screen.

■3 Utilizing the project containing a different GOT type setting
Utilized data is converted according to the GOT type set in the destination project.
Functions that does not correspond to the GOT type of the destination project are not eliminated.

■4 Utilizing the project containing different controller settings
When [Retain the CH No.] is selected in the [Utilize] dialog ([Controller Setting]), the devices set for the objects on the 
utilized screens will be changed as shown below.

• The device name is changed according to the controller setting in the destination project.
• The device to which the controller setting in the destination project does not correspond is changed to [??] (except 

the devices in the script data)
Check the device setting and set it again.

■5 Utilizing the project read from the GOT
Right after the project is read from the GOT, the [Utilize Data (Project)] dialog and others do not display the screen images 
set in the project.
To display the screen images set in the project, open the project read from the GOT, and save the project again.

■6 Utilizing the project in which a system label is set
In the project being edited, when [Use system labels in conjunction with MELSOFT Navigator] of the [Type Setting] dialog 
is unchecked, the data of the screens from the project where a system label is set cannot be utilized.

➟5.1.5 [Type Setting] dialog

■7 Utilizing the project in which Windows fonts are used for comment groups
If the Windows fonts used for comment groups are not installed on the personal computer, the comments are displayed in 
different fonts.
To display the comments in the specified Windows fonts, make sure that the fonts are installed on the personal computer 
before utilizing the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■8 Utilizing the project created with GT Designer3 version earlier than 1.205P
When [Same resolution as the current project] is selected for [GOT Type] in the [Utilize Data (Screen)] window, if you 
search for the projects created with GT Designer3 version earlier than 1.205P, the results will be listed as shown below.

• All the projects matching the specified resolution are listed without distinction of the GOT installation orientation.
• If [GOT Type] is set to [GT SoftGOT2000] in the destination project, the projects for GT SoftGOT2000 are listed 

without distinction of the GOT resolution.
• If [GOT Type] is set to any item other than [GT SoftGOT2000] in the destination project, the projects for GT 

SoftGOT2000 are not listed.
To eliminate the above problems, save the relevant projects with GT Designer3 version 1.205P or later.

■9 Utilizing base screens for which the window preview is set
The window preview settings of the source project will be migrated to the destination project if [Apply to all base screens] is 
deselected in the [Window Preview] dialog in the destination project.
If [Apply to all base screens] is selected in the destination project, the window preview settings of the destination project will 
be applied.

➟2.9.2 Displaying the preview of a window screen on the screen editor

■10 Utilizing screen data from a project created with a different version of GT Designer3
If you use GT Designer3 version earlier than the version of GT Designer3 that has been used to create the source project, 
you cannot utilize the settings of controllers unsupported.
For the correspondences between GT Designer3 versions and supported controllers, refer to the following.

➟12.17 Upgraded Additional Function List
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11.1.4 [Utilize Data (Project)] dialog and [Search] dialog

The dialog name varies with the display method.
• The [Utilize Data (Project)] dialog is displayed by selecting [Project] → [Utilize Data] from the menu.
• The [Search] dialog is displayed from the [Utilize Project] dialog.

Add-on projects cannot be searched in the [Search] dialog.

1) [Target]
Select the target for a search.
The following shows the items to be selected.

• [Add-on project]:
This item appears when the add-on license has been registered.

➟11.1.8 Registering the add-on license
Searches the add-on projects.

• [Sample project]
Search from the sample project installed with GT Designer3.

• [Recently edited project]
Search from the recently edited project (up to 5 projects).
When GT Designer3 is started from MELSOFT Navigator, the project edited with GT Designer3 is not included 
in the search targets.

• [Project folder]
Search from the projects in the specified folder.
The search target is up to the projects of the folder existing in the lower three hierarchy.
Up to 1000 projects can be included in the search targets.
Specify the holder from the [Browse] button.

2) [Category]
When [Target] is set to [Add-on project], select a project type.
The following shows the items to be selected.

• [MR-J4-B(-RJ) (Simple Motion)]
• [MR-J4-B(-RJ) (Motion Controller)]

3) [Keyword]
Specify the keyword for a search.
Two-byte and one-byte characters are recognized.
Specifying keywords delimited with one-byte or two-byte spaces enables you to narrow the scope of a search to 
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the projects containing the keywords.
Adding "!" before keywords can search the projects on which the specified keywords are not included.
Up to five history is displayed.

4) [Search] button
Searching

5) [Detail >>] button and [Detail <<] button
Switch displaying and not displaying the following setting items.

• [GOT Type]
• [Controller]
• [Last Update]

Even though the above setting items are not displayed, they can be included in the targets for a search.
6) [GOT Type]

Select a GOT type by which projects are searched.
The following shows the items to be selected.

• [All GOT Types]
• Options for [Type] in the [Type Setting] dialog
➟5.1.5 [Type Setting] dialog

7) [Controller]
Select the controller type for the project to be searched.
The items to be selected are the same as [Type] in setting the channel on the [Controller Setting] window.

➟12.2 Correspondence between the setting of [Controller Type] and the controller used
8) [Last Update]

Select the last update of the project to be searched.
The following shows the items to be selected.

• [Not specify]
• [Within the last 24 hour]
• [Within the last week]
• [Within the past month]
• [Within the past year]
• [Over a year ago]

9) [Search Result]
Number of searched projects

10) Search result list
List of searched projects

11) [Preview]
Screen images set in the projects selected in the search result list

12) [Information] button
Switch displaying and not displaying the following items.

• [Information]
• [Project Title]
• [Project Path]
• [Controller]

13) [Zoom in] button
Zoom in the display of [Preview].

14) [Zoom out] button
Zoom out the display of [Preview].

15) [Detailed Description]
Detail description of the project selected in the search result list

16) [Manual] button
Displays the PDF manual for add-on projects when [Target] is set to [Add-on project].
Displays the PDF manual for sample projects when [Target] is set to [Sample project].

17) [Project Title]
Title of the project selected in the search result list

18) [Project Path]
Save folder path of the project selected in the search result list

19) [Controller]
Controller setting(type) of the project selected in the search result list
11. USEFUL FUNCTIONS
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11.1.5 [Utilize Data (Screen)] window

1) [Target]
Select the target for a search.
The following shows the items to be selected.

• [Add-on project]:
This item appears when the add-on license has been registered.

➟11.1.8 Registering the add-on license
Searches the add-on projects.

• [Sample project]
Search from the sample project installed with GT Designer3.

• [Recently edited project]
Search from the recently edited project (up to 5 projects).
When GT Designer3 is started from MELSOFT Navigator, the project edited with GT Designer3 is not included 
in the search targets.

• [Project folder]
Search from the projects in the specified folder.
The search target is up to the projects of the folder existing in the lower three hierarchy.
Up to 1000 projects can be included in the search targets.
Specify the holder from the [Browse] button.

2) [Category]
When [Target] is set to [Add-on project] or [Sample project], select a project type.
The selectable items vary depending on the setting of [Target].
When [Target] is set to [Add-on project], the following items are selectable.

• [MR-J4-B(-RJ) (Simple Motion)]
• [MR-J4-B(-RJ) (Motion Controller)]

When [Target] is set to [Sample project], the following items are selectable.
• [All]
• [Alarm]
• [Recipe]
• [Logging]
• [GOT Mobile]
• [I/O Monitor]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [CC-Link Network Monitor]
• [AnyWireASLINK Network Monitor]
• [iQSS Backup/Restoration]
• [Document Display (PDF Search)]
• [Script Error Monitor]
• [MITSUBISHI ELECTRIC (Programmable Controller)]
• [MITSUBISHI ELECTRIC (Servo)]
• [MITSUBISHI ELECTRIC (Inverter)]
• [MITSUBISHI ELECTRIC (Other)]
• [SMC]
• [YASKAWA]
• [IAI]
• [ORIENTAL MOTOR]
• [PATLITE]
• [Temperature Controller]
• [Want to display numerical data]
• [Want to display an alarm]
• [Want to display a figure/text]
• [Want to display the panel status]
• [Want to operate the panel]
• [Want to display a graph]
• [Want to copy a file to SD card]
• [Want to register a favorite screen]

3) [Detail >>] button and [Detail <<] button
Switch displaying and not displaying the following setting items.

• [GOT Type]
• [Controller]
• [Last Update]

Even though the above setting items are not displayed, they can be included in the targets for a search.
4) [GOT Type]

Select a GOT type by which projects are searched.
The following shows the items to be selected.

• [All GOT types]:
Selects all GOT types.

• [Same as the current project]:
Selects the GOT type specified in the destination project.

• [Same resolution as the current project]:
Selects the GOT type whose resolution and installation orientation are identical to the ones specified in the 
destination project.

• Options for [Type] in the [Type Setting] dialog
➟5.1.5 [Type Setting] dialog

5) [Controller]
Select the controller type for the project to be searched.
The items to be selected are the same as [Type] in setting the channel on the [Controller Setting] window.

➟12.2 Correspondence between the setting of [Controller Type] and the controller used
6) [Last Update]

Select the last update of the project to be searched.
The following shows the items to be selected.

• [Not specify]
• [Within the last 24 hour]
• [Within the last week]
• [Within the past month]
• [Within the past year]
• [Over a year ago]

7) [Keyword]
Specify the keyword for a search.
Two-byte and one-byte characters are recognized.
11. USEFUL FUNCTIONS
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Specifying keywords with one-byte spaces between the keywords can search the screens on which the specified 
keywords are included.
Up to five history is displayed.

8) [Search] button
Conducts a search.

9) [Project]
Select a project, narrowing down the thumbnails of found screens in the search result list.
The following shows the items to be selected.

• [All projects]
• Individual projects

10) Search result list
Thumbnails of found screens.
Multiple screens are selectable from within the same project.

11) [Select All] button
Selects all the screens in the project which includes the screen selected in the search result list.

12) [Deselect All] button
Deselects all the screens selected in the search result list.

13) [Information] button
Displays or hides the following items.

• [Information]
• [Project Title]
• [Project Path]
• [Controller]

14) [Zoom in] button
Zoom in the display of search result list.

15) [Zoom out] button
Zoom out the display of search result list.

16) [Manual] button
Displays the PDF manual for add-on projects when [Target] is set to [Add-on project].
Displays the PDF manual for sample projects when [Target] is set to [Sample project].

17) [Search Result]
Number of found screens.

18) [Detailed Description]
Detail description of the screen selected in the search result list

19) [Project Title]
Title of the project including the screen selected in the search result list

20) [Project Path]
Save folder path of the project including the screen selected in the search result list

21) [Controller]
Controller setting(type) of the project including the screen selected in the search result list

22) [Utilize] button
Displays the [Utilize] dialog.

➟11.1.6 [Utilize] dialog
11 - 14 11. USEFUL FUNCTIONS
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11.1.6 [Utilize] dialog

Configure the settings to utilize a screen.

In the process navigation bar, the color of each step represents the status of the step.

➟■1 [Target Screen Setting]
■2 [Related Setting Edit]
■3 [Controller Setting]
■4 [Unit No./Axis No. Setting]
■5 [Confirmation]

Display image Status

Active

Done

Undone

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 [Target Screen Setting]

Set the screen number of a screen to be utilized in the destination project.

1) [Screen Type]
Type of a target screen.

2) [Screen No.]
Screen number of a target screen.
Change the screen number as necessary.
The screen number is displayed in red if it is used in the destination project.
Click the [...] button to display the [Detail Screen Setting] dialog.

➟11.1.7 [Detail Screen Setting] dialog
3) [Title]

Title of a target screen.
4) [Detailed Description]

Detailed description of a target screen.
5) [Source Screen]

If a target screen is specified as a called screen for the set overlay screen function, the screen number of the calling 
screen is displayed.

6) [Previous Screen]
If a target screen is specified as the screen to be switched to in a touch switch setting, the screen number of the 
switched screen is displayed.

7) [Include the screens specified for the switching destinations of objects (switches, parts 
displays, simple alarm displays)]
Utilizes the screen that is specified as the screen to be switched to in the setting of a touch switch, parts display, or 
simple alarm display.
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■2 [Related Setting Edit]

Set whether to utilize the settings related to the screen to be utilized, and assign setting numbers.

1) [Utilize screen-related common settings as well]
Utilizes the settings related to the target screen.

2) [Utilize Label (GT Designer3) set for screens and common settings as well]
This item appears when labels (GT Designer3) are used in the target screen and the settings related to the screen.
Utilizes the relevant label groups.
For information on how to display this item, refer to the following.

➟11.1.2 ■2 Utilizing a screen
3) Setting list

Lists the settings related to the target screen.
The existing settings are displayed only.

• [Network Drive]
• [GOT Mobile Setting]
• [Comment Group]
• [User Alarm Observation]
• [System Alarm Observation]
• [Logging]
• [Recipe Common Setting]

This item appears when the target screen is included in an add-on project.
• [Recipe]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Script (Project)]
A project script is utilized when [Include this script in a screen-related setting when utilizing project/screen] is 
selected in the [Script Edit] dialog.

• [Script List]
• [Object Script Symbol]
• [Device Data Transfer]

This item appears when the target screen is included in an add-on project.
• [Trigger Action (Project)]

This item appears when the target screen is included in an add-on project.
• [Parts]
• [Sound File]

4) [Overwrite the network drive setting]
This item appears when [Network Drive] is selected in the setting list.
Utilizes the network drive settings.

5) [Overwrite the GOT Mobile setting]
This item appears when [GOT Mobile Setting] is selected in the setting list.
Utilizes the settings of the GOT Mobile function.

6) [Overwrite the recipe common setting]
This item appears when [Recipe Common Setting] is selected in the setting list.
Utilizes the recipe common settings.

7) [Target Screen]
Lists the utilizable settings.

The text color of a setting represents the status of the setting.

For mouse and keyboard operations, refer to the following.
➟(1) Mouse and keyboard operations

8) [Current Project]
Lists the settings in the destination project.

The text color of a setting represents the status of the setting.

In [Current Project], the assigned number is changeable with the [Up] button or the [Down] button.
For mouse and keyboard operations, refer to the following.

➟(1) Mouse and keyboard operations
9) [Add] button

Adds the setting selected in [Target Screen] to the row selected in [Current Project].

Item Description

[No.] Number of each setting in the source project.

[Name] Name of each setting in the source project.

Text color Description

Black
Setting that is not added to [Current Project].
To utilize a setting in the destination project, add the setting to [Current Project] with the 
[Add] button.

Gray Setting added to [Current Project].

Item Description

[Skip blank rows] Only displays the rows where a setting is present.

[No.] Number of each setting in the destination project.

[Name] Name of each setting in the destination project.

[State]
Assignment status of each setting.
• [Added]: Setting added from [Target Screen]
• [Overlap]: Duplicate setting number in the destination project

Text color Description

Black Setting existing in the destination project.

Blue Setting added from [Target Screen].

Red Duplicate setting number in the destination project.
11 - 18 11. USEFUL FUNCTIONS
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If no row has been preselected in [Current Project], the [Destination Data No. Specification] dialog appears.
Specify a setting number to be assigned in the destination project.

10) [Delete] button
Deletes the setting selected in [Current Project].

11) [Up] button, [Down] button
Moves the setting selected in [Current Project] up or down.

12) [Specify No.] button
Displays the [Destination Data No. Specification] dialog.
Change the setting number of the setting selected in [Current Project].

13) [Add All] button
Adds all the settings listed in [Target Screen] to [Current Project].
The settings are added to the selected row and subsequent rows in [Current Project].
If no row has been preselected in [Current Project], each setting is added with its setting number unchanged.

14) [Delete All] button
Deletes all the added settings from [Current Project].

(1) Mouse and keyboard operations
The following shows the mouse and keyboard operations in [Target Screen] and [Current Project].

• [No.]
Specify a setting number to be assigned in the destination project.
The setting range varies depending on the setting to be utilized.

Operation [Target Screen] [Current Project]

Arrow (up, down) Moves the cursor.

[Shift] + Arrow (Up/Down)
Moves the row while selecting the row where the cursor 
is positioned 
The destination row of the cursor is also selected.

-

[Home] Moves the cursor to the top row.

[End] Moves the cursor to the bottom row.

[PageUp] Moves the cursor up one page.

[PageDown] Moves the cursor down one page.

[Shift] + [Home] Selects the rows from the row where the cursor is 
positioned to the top row. -

[Shift] + [End] Selects the rows from the row where the cursor is 
positioned to the bottom row. -

[Shift] + [PageUp]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves up one 
page.

-

[Shift] + [PageDown]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves down one 
page.

-

[Shift] + Click Selects the rows from the row where the cursor is 
positioned to the row where the mouse is clicked. -

[Ctrl] + [Space]
Selects or deselects a row.

Selects or deselects a row.

[Ctrl] + Click -
11. USEFUL FUNCTIONS
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■3 [Controller Setting]

Select a channel for each controller type to be used in the destination project.

1) [Controller setting of the target screen]
Controller settings in the source project.

2) [Controller setting in the current project]
Controller settings in the destination project.
Select a channel for the controller type displayed in [Controller setting of the target screen].
The following shows selectable items.
Unavailable items are grayed out.

• [CH1]
• [CH2]
• [CH3]
• [CH4]
• [Retain the CH No.]

You can select the channel used for a different controller type in the destination project.
In this case, the channel number and controller type specified in the destination project will be applied.
Check the device setting after the utilization.

When [Type] is set to [GT SoftGOT2000] in the [Type Setting] dialog in the destination project, [CH2] to [CH4] are 
selectable if all the following conditions are satisfied.

• A controller that can be monitored by GT SoftGOT2000 is set, and the Ethernet connection or OPC UA client 
connection is set for the controller in the destination project.
• The Ethernet connection or OPC UA client connection is set for channel No. 1 in the destination project.

3) [Reset] button
Resets the settings in [Controller setting in the current project] for all channels.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■4 [Unit No./Axis No. Setting]

If necessary, change the unit number and the axis number (axis designation) set to an applicable device used in the target 
screens.
The settings are configurable in the [Unit No./Axis No. Batch Edit] dialog as well.

➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

1) [Before]
Unit number and axis number (axis designation) set to each applicable device used in the target screens.

2) [After]
If necessary, change the unit number and axis number (axis designation) to be used in the destination project.
Click the setting button to display the unit No./axis No. setting dialog.
The setting items vary according to the selected module.

• Unit
Select a module to be routed to.

• [Unit No.]
Specify a unit number.

• [Axis No.]
Specify an axis number.

• [Axis Designation]
Specify an axis.
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■5 [Confirmation]

The following set contents are displayed.
• Duplicate screen number or setting number
• Controller setting

Confirm the set contents, and execute the screen utilization.
To change the settings, go back to the relevant step with the [Back] button or the process navigation bar.

1) [Screen Setting]
If a duplicate screen number exists in the destination project, the screen type and screen number are displayed.

➟■1 [Target Screen Setting]
2) [Common Setting]

If a duplicate setting number exists in the destination project, the setting type and setting number are displayed.
➟■2 [Related Setting Edit]

3) [Controller Setting]
Settings made in [Controller Setting].

4) [State]
Assignment status of each setting.

• [Overlap (overwrite)]
A duplicate screen number or setting number exists in the destination project.
If you click the [Finish] button without resolving of the duplication, the existing setting is overwritten.

• [CH No./controller change]
The channel number and controller type are changed to the ones specified in the destination project.

• [Controller changed]
The controller type is changed to the one specified in the destination project.

• [CH No. changed]
The channel number is changed to the one specified in the destination project.

• [No change]
The channel number and controller type remain unchanged.

• [Added]
The controller settings are assigned to an unused channel in the destination project.

• [Unspecified (CH No. retained)]
The channel number remains unchanged, and the controller type is changed to the one specified in the 
destination project.

5) [Finish] button
Executes the screen utilization.
If the script data storage destination is set to [Project Data (Internal Data)] in the source project and to [External File 
(External Data)] in the destination project, a dialog will appear asking where to save a script file.
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Set a folder to save the script file.
➟9.9.5 ■4 [Option] tab

If a label (GT Designer3) error occurs after the screen utilization, the [Label Check] dialog will appear.
Correct the setting of the relevant label (GT Designer3).

➟6.1.5 ■4 Label check
If you select a channel being used in the destination project, check the device settings after the screen utilization.

11.1.7 [Detail Screen Setting] dialog

Change the screen number of a screen to be utilized.

1) Screen type
The screen types of target screens are listed.

• [Base Screen]
• [Window Screen]
• [Mobile Screen]

2) [Target Screen]
Lists the utilizable screens.

3) [Current Project]
Lists the settings in the destination project.

Item Description

[Screen No.] Screen number of each screen in the source project.

[Title] Title of each screen in the source project.

Item Description

[Skip blank rows] Only displays the rows where a screen setting is present.

[Screen No.] Screen number of each screen in the destination project.

[Title] Title of each screen in the destination project.

[State]
Assignment status of each screen setting.
• [Added]: Screen setting added from [Target Screen]
• [Overlap]: Duplicate screen number in the destination project
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The text color of a screen setting represents the assignment status of the setting.

In [Current Project], the assigned number is changeable with the [Up] button or the [Down] button.
4) [Up] button, [Down] button

Moves the screen setting selected in [Current Project] up or down.
5) [Specify No.] button

Displays the [Destination Data No. Specification] dialog.
Change the screen number of the screen selected in [Current Project].

11.1.8 Registering the add-on license

To utilize an add-on project, purchase and register the add-on license.
For details on purchasing the add-on license, contact your local sales office.
For details on registering the add-on license, refer to the following.

➟Instructions for Registering the GT Works3 Add-on License for GOT2000 Enhanced Drive Control (Servo) 
Project Data

Text color Description

Black Screen setting existing in the destination project.

Blue Screen setting added from [Target Screen].

Red Duplicate screen number in the destination project.

• [No.]
Set the screen number of a screen to be utilized in the destination 
project.
The setting range is [0] to [32767].
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11.2 Registering the Labels (GT Designer3) Created from Profile Data

Register the labels (GT Designer3) created from the profile (CSP+) data that is stored in the personal computer.
As label groups and labels (GT Designer3) are created automatically in the registration process, you do not need to 
perform these tasks manually.

➟11.2.1 Conditions to register the labels (GT Designer3) created from profile data
11.2.2 Specifications of the labels (GT Designer3) created from profile data
11.2.3 How to register the labels (GT Designer3) created from profile data
11.2.4 [Project Specification] dialog
11.2.5 [Label (GT Designer3) Auto Registration] dialog

11.2.1 Conditions to register the labels (GT Designer3) created from profile data

The labels (GT Designer3) created from profile data are registrable if all the following conditions are satisfied.

■1 GX Works3
(1) GX Works3 version

The required GX Works3 version depends on the GX Works3 project used.

(2) Profile registration
The personal computer has the profile data from which labels (GT Designer3) are created.
For information on how to register a profile, refer to the following.

➟Help for MELSOFT Navigator
GX Works3 Operating Manual

(3) Profile language
The profile language is English or the same as the language version of GT Designer3.

(4) Network specified in the target GX Works3 project
The CC-Link IE Field Network is specified in the target GX Works3 project.

■2 GT Designer3
(1) Controller setting

In the [Controller Setting] window, [Controller Type] is set to one of the following items.
• [MELSEC iQ-R, RnMT/NC/RT, CR800-D]
• [MELSEC iQ-R, RnMT/RT, CR800-D]
• [MELIPC]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GX Works3 project GX Works3 version

Uncompressed project data Version 1.045X or later

Compressed project data Version 1.050C or later

Security version 2 project data Version 1.095Z or later
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11.2.2 Specifications of the labels (GT Designer3) created from profile data

For the basic specifications of labels (GT Designer3), refer to the following.
➟6.1.5 How to set labels (GT Designer3)

■1 Label group number
Label groups are numbered in descending order, starting from 200.
If any label group number already exists, the number is skipped.

■2 Label group name
A label group is named using the equipment name selected in the list of network-connected equipment.

➟11.2.5 ■2 [I/O Information Specification]
If a same-name label group already exists, an underscore character (_) and a number will be appended.
The following characters will be deleted from the equipment name to be a label group name.

• Numbers prefixed to the equipment name
• Symbols unavailable for a label name
• Excess characters when the maximum length of a label group name is exceeded

■3 Data types to be registered
The following shows the correspondences between the data types used in profile data and the ones of labels (GT 
Designer3) to be registered.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Data type used in profile data Data type of a label (GT Designer3)

BOOL
BIN1

Bit

BIN2 to BIN16 Unsigned BIN 16

BIN32 Unsigned BIN 32

BYTE
WORD
BIT_STRING2 to BIT_STRING15

Unsigned BIN 16

DWORD Unsigned BIN 32

INT2 to 16 Signed BIN 16

INT32 Signed BIN 32

UINT2 to 16 Unsigned BIN 16

UINT32 Unsigned BIN 32

BCD4
BCD8
BCD12
BCD16

BCD16

BCD32 BCD32

STRUCT Unsigned BIN 16
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11.2.3 How to register the labels (GT Designer3) created from profile data

Step 1 Select [Project] → [Import Other Data] → [Profile (CSP+)] → [Label (GT Designer3) Auto Registration] from 
the menu to display the [Project Specification] dialog.
Specify the path to an applicable GX Works3 project.

➟11.2.4 [Project Specification] dialog

Step 2 Click the [OK] button to display the [Label (GT Designer3) Auto Registration] dialog.

➟11.2.5 [Label (GT Designer3) Auto Registration] dialog
Step 3 Select a target network, and click the [Next] button.

➟11.2.5 ■1 [Network Configuration Specification]

Step 4 Select the link devices that labels (GT Designer3) are based on, and click the [Next] button.

➟11.2.5 ■2 [I/O Information Specification]

Step 5 Select a language for the comments to be used for labels (GT Designer3), and click the [Utilize] button to 
register labels (GT Designer3).

➟11.2.5 ■3 [Language Setting]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.2.4 [Project Specification] dialog

Select [Project] → [Import Other Data] → [Profile (CSP+)] → [Label (GT Designer3) Auto Registration] from the menu to 
display the [Project Specification] dialog.

1) [CH No.]
Select a channel number to connect the controller that is specified in the target GX Works3 project.
Channels are selectable if one of the following controller types is selected in the [Controller Setting] window.

• [MELSEC iQ-R, RnMT/NC/RT, CR800-D]
• [MELSEC iQ-R, RnMT/RT, CR800-D]
• [MELIPC]

2) [Network Setting]
Specify the network that is set in the target GX Works3 project.

3) [File Path]
Specify the path to the target GX Works3 project.

4) [OK] button
Confirms the entries, and displays the [Label (GT Designer3) Auto Registration] dialog.

➟11.2.5 [Label (GT Designer3) Auto Registration] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)
3)

4)
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11.2.5 [Label (GT Designer3) Auto Registration] dialog

In the [Project Specification] dialog, click the [OK] button to display the [Label (GT Designer3) Auto Registration] dialog.
Configure the settings to register labels (GT Designer3) automatically.

In the process navigation bar, the color of each step represents the status of the step.

➟■1 [Network Configuration Specification]
■2 [I/O Information Specification]
■3 [Language Setting]

Display image Status

Active

Done

Undone

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Process navigation bar
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■1 [Network Configuration Specification]
Select a target network from the list.

1) [Network]
Type of a network.
Each row displays a network configuration.
Select a target network.

2) [Control CPU]
Model of the PLC CPU on the master station.

3) [Master Unit]
Model of a module on the master station.

4) [Network No.]
Number of a network.

5) [Configuration Device]
Select a row to display the [List] button.
Click the [List] button to display the [Configuration Device List] dialog where you can check the equipment on the 
relevant network.

■2 [I/O Information Specification]
Select the link devices that labels (GT Designer3) are based on.

1) List of network-connected equipment
Lists the equipment on the network that has been selected in [Network Configuration Specification].
Equipment with its profile unregistered is not listed.
Select equipment to display its link devices in [I/O Information].

2) [I/O Information]
Link devices set for the selected equipment.

1) 2) 3) 4) 5)

1)

2)

4)

3)
11 - 30 11. USEFUL FUNCTIONS
11.2 Registering the Labels (GT Designer3) Created from Profile Data



U
SE

FU
L 

FU
N

C
TI

O
N

S

11
Select the link devices that labels (GT Designer3) are based on.
3) [Select All] button

Selects all items in [I/O Information].
4) [Deselect All] button

Deselects all items in [I/O Information].

■3 [Language Setting]
Select a language for the comments to be used for labels (GT Designer3).

1) [Comment Column No.1], [Comment Column No.2], or [Comment Column No.3]
Select a language for the comments to be used.
The comments are used from the profile data in the selected language.
The following shows selectable items.

• [Not Used]
• [Japanese]
• [English]
• [Chinese(GB)]

If you select the language of an unregistered profile or [Not Used], the relevant comment column will be blank.

1)
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11.3 Setting Devices from Device Comments (Input Assist)

Search device comments and device definitions with keywords, and narrow down utilizable devices.
Without opening the setting dialog of the device, you can search and set devices with using the setting dialog for the object 
and others.
To search the device comments, importing the device comments is required.

➟11.3.1 Specifications of the input assist
11.3.2 How to use the input assist
11.3.3 Input assist window
11.3.4 [Input Assist Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.3.1 Specifications of the input assist

➟■1 Search target
■2 Specifications of keywords

■1 Search target

The following shows the search targets of keywords.

■2 Specifications of keywords

The following shows the characters specified for uses.
• @
Specify the channel No.with @n. (n indicates No.)
You can search devices of the given channel Nos.
Example) @2 indicates CH2.

• One-byte space
You can search with multiple keywords by specifying keywords with one-byte spaces between the keywords.

• "
You can search the keyword including @ or a one-byte space with using quotation marks around a keyword.
Example) Input "@" to search device comments including @.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search target Description

Device comment
The device comments are searched.

➟6.1.6 ■1 Importing device comments and device definitions

Device definition
The device definitions are searched.

➟6.1.6 ■1 Importing device comments and device definitions

System label
The system labels are searched.

➟6.1.3 How to set system labels

Global label
The global labels are searched.
GT21 and GS21 do not support global labels.

➟6.1.4 How to set global labels

Label (GT Designer3)
The labels (GT Designer3) are searched.

➟6.1.5 How to set labels (GT Designer3)

OMRON NJ/NX tag
The OMRON NJ/NX tags are searched.
GT2105-Q does not support OMRON NJ/NX tags.

➟6.1.7 How to set OMRON NJ/NX tags

AB native tag
The AB native tags are searched.
GT21 and GS21 do not support AB native tags.

➟6.1.9 How to set AB native tags

OPC UA tag
The OPC UA tags are searched.
Only available to GT SoftGOT2000.

➟6.1.10 How to set OPC UA tags

Device

The device names and the device numbers are searched.
Representation for devices of the GOT and controllers might be different.
Uses device representation for the GOT for a search.

➟12.4 Device Range and Settings of Each Controller

Function name of the GOT internal 
devices

The function names of the GOT internal devices are searched.
For the function name of each GOT internal device, refer to the following.

➟12.1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.3.2 How to use the input assist

➟■1 Preparation for the input assist
■2 Searching devices by a keyword to set a device
■3 Changing the sorting order of utilizable data
■4 Narrowing down the search target
■5 Switching available or unavailable for the input assist

■1 Preparation for the input assist

Devices (device name and device No.) and function names of the GOT internal devices are the search target by default.
([Show the device comment/definition/label settings] or [Show the device comment/definition/label/tag settings] is 
selected by default in the [Input Assist Setting] dialog.)
To narrow a search to the device comments, device definitions, or others, set the following.

(1) Narrowing a search to device comments

To search device comments, satisfy all the following conditions.
• Import a device comment.

➟6.1.6 ■1 Importing device comments and device definitions
• Select [Show the device comment/definition/label settings] or [Show the device comment/definition/label/tag settings] 

in the [Input Assist Setting] dialog.
➟11.3.4 [Input Assist Setting] dialog

(2) Narrowing a search to device definitions

To search device definitions, satisfy all the following conditions.
• Import the device definition of the station number to be used.(As station number 0 is always the search target, 

importing is not necessary.)
• Select [Show the device comment/definition/label settings] or [Show the device comment/definition/label/tag settings] 

in the [Input Assist Setting] dialog.
➟11.3.4 [Input Assist Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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For the following controllers, just selecting [Show the device comment/definition/label settings] or [Show the device 
comment/definition/label/tag settings] narrows a search to device definitions.

*1 The device definitions of the following controllers are searched for.
• FR-A800 series
• FR-A800 Plus series (FR-A8□0-CRN, FR-A8□2-CRN, FR-A8□0-R2R, FR-A8□2-R2R, FR-A8□0-E-CRN, FR-A8□2-

E-CRN, FR-A8□0-E-R2R, FR-A8□2-E-R2R, FR-A8□0-AWH, FR-A8□0-E-AWH, FR-A8□0-LC, and FR-A8□0-E-LC)
• FR-F800 series
• FR-E800 series (FR-E8□0 and FR-E8□0-E)
• FR-A700 series
• FR-F700 series
• FR-F700P series
• FR-F700PJ series
• FR-E700 series
• Sensorless servo (FR-E7□0EX)

[Manufacturer] [Controller Type] Search target

[MITSUBISHI ELECTRIC]

[MELSEC iQ-R, RnMT/NC/RT, CR800-D]
([MELSEC iQ-R, RnMT/RT,CR800-D] for GT21 and 
GS21)

Device definitions (special relays and special 
registers only)

[MELSEC iQ-L] Device definitions (special relays and special 
registers only)

[MELSEC iQ-F] Device definitions (special relays and special 
registers only)

[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]
([MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700] for GT21 
and GS21)

Device definitions (special relays and special 
registers only)

[MELSEC-QnA, MELDAS C6*]
([MELSEC-QnA] for GT21 and GS21)

Device definitions (special relays and special 
registers only)

[MELSEC-L] Device definitions (special relays and special 
registers only)

[MELSEC-A] Device definitions (special relays and special 
registers only)

[MELSEC-FX] Device definitions (special relays and special 
registers only)

[MELIPC] Device definitions (special relays and special 
registers only)

[MELSERVO-J2M-P8A] Device definitions

[MELSERVO-J2M-*DU] Device definitions

[MELSERVO-J2S-*A] Device definitions

[MELSERVO-J2S-*CP] Device definitions

[MELSERVO-J2S-*CL] Device definitions

[MELSERVO-J3-*A] Device definitions

[MELSERVO-J3-*T] Device definitions

[MELSERVO-J4-*A, -JE-*A] Device definitions

[MELSERVO-J4-*A-RJ] Device definitions

[MELSERVO-JE-*C] Device definitions

[MELSERVO-J5(W)-*G(-RJ), -JET-*G] Device definitions

[FREQROL 500/700/800, SENSORLESS SERVO] Device definitions *1

[FREQROL 800] Device definitions

[FREQROL 800/E700NE(Batch monitor)] Device definitions

[IAI]
[IAI X-SEL Controller] Device definitions

[IAI ROBO CYLINDER] Device definitions

[azbil] [Azbil DMC50] Device definitions
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(3) Narrowing a search to system labels

To search system labels, satisfy all the following conditions.
• Configure the setting so that the system labels can be used.

➟6.1.3 How to set system labels
• Select [Show the device comment/definition/label settings] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog

(4) Narrowing a search to global labels

To search global labels, satisfy all the following conditions.
• Import global labels.

➟6.1.4 How to set global labels
• Select [Show the device comment/definition/label settings] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog

(5) Narrowing a search to labels (GT Designer3)

To search labels (GT Designer3), satisfy all the following conditions.
• Register labels (GT Designer3).

➟6.1.5 How to set labels (GT Designer3)
• Select [Show the device comment/definition/label settings] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog

(6) Narrowing a search to OMRON NJ/NX tags

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
To search OMRON NJ/NX tags, satisfy all the following conditions.

• Import OMRON NJ/NX tags.
➟6.1.7 How to set OMRON NJ/NX tags

• Select [Show the device comment/definition/label/tag settings] in the [Input Assist Setting] dialog.
➟11.3.4 [Input Assist Setting] dialog

(7) Narrowing a search to AB native tags

Only available to GT SoftGOT2000 (Multiple channels) for GT SoftGOT2000.
To search AB native tags, satisfy all the following conditions.
• Import AB native tags.

➟6.1.9 How to set AB native tags
• Select [Show the device comment/definition/label/tag settings] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog

(8) Narrowing a search to OPC UA tags

To search OPC UA tags, satisfy all the following conditions.
• Import OPC UA tags.

➟6.1.10 How to set OPC UA tags
• Select [Show the device comment/definition/label/tag settings] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Searching devices by a keyword to set a device

Step 1 Input a keyword in the device entry field in the setting dialog of the object and others to display the input 
assist window.
You can switch the contents displayed in the input assist window with the display switching buttons.
➟11.3.3 Input assist window

Step 2 Operate any one of the following to set the device in the device entry field.
• Click the device to be set.
• Select the device to be set with up and down arrow keys on the keyboard, and push the [Enter] key or the [Tab] 

key.
Using @ or one-byte spaces can search the devices for the given channels or use multiple keywords for a search.

➟11.3.1 ■2 Specifications of keywords

■3 Changing the sorting order of utilizable data

➟(1) Changing the sorting order with one condition
(2) Changing the sorting order with multiple conditions

(1) Changing the sorting order with one condition

In the input assist window, click a column header to sort the devices in order of the item corresponding to the header.
Each click switches to the ascending order, descending order, and no sort, in that order.
Example) Sorting the devices in ascending order of device comments

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Input assist window

Device entry field

Display switching buttons

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Click [Device Comment]. The sorting order is changed.
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(2) Changing the sorting order with multiple conditions

Step 1 Perform one of the following operations to display the [Input Assist Setting] dialog.
• Click the setting button for the input assist window.
• Right-click on the device entry field, and select [Input Assist Setting] from the menu.

Step 2 Set the sorting order with [Sort] of the [Input Assist Setting] dialog.
Up to three conditions for sorting order can be set and their priority is high from the top.

➟11.3.4 [Input Assist Setting] dialog
Example) Setting [Comment/Definition] for the first condition and [Label/Device Name] for the second 
condition

Step 3 Click the [OK] button to change the sorting order.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting button Right-click menu
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■4 Narrowing down the search target

Step 1 Perform one of the following operations to display the [Input Assist Setting] dialog.
• Click the setting button for the input assist window.
• Right-click on the device entry field, and select [Input Assist Setting] from the menu.

Step 2 Change the search target with [Search Target] of the [Input Assist Setting] dialog.

➟11.3.4 [Input Assist Setting] dialog
Example) Changing the [Search Target] to [Comment/Definition]

Step 3 Click the [OK] button to change the search target.

■5 Switching available or unavailable for the input assist

Step 1 Perform one of the following operations to display the [Input Assist Setting] dialog.
• Click the setting button for the input assist window.
• Right-click on the device entry field, and select [Input Assist Setting] from the menu.

Step 2 In the [Input Assist Setting] dialog, set whether to automatically display the input assist window, and set the 
items to be displayed as required.

➟11.3.4 [Input Assist Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting button Right-click menu

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Setting button Right-click menu
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• [Automatically display the input assist window]
Clear this item not to display the input assist window even though a keyword is entered in the device 
input field.

• [Show the device comment/definition/label settings] or [Show the device comment/definition/label/tag 
settings]
Clear this item to display only the history of the device setting on the input assist window.

11.3.3 Input assist window

1) [Device Name], [Label Name], [Tag Name]
Switch the ascending order, descending order, no sort in order every clicking the mouse.

2) [Device Comment], [Device Definition], [Comment ]
Switch the ascending order, descending order, no sort in order every clicking the mouse.
Not displayed when [Show the device comment/definition settings] of the [Input Assist Setting] dialog is deselected.
(When labels are available, [Show the device comment/definition/label settings] is displayed instead.)

3) [Remark]
Display [(History)] in the devices saved in the setting history.
Switch the ascending order, descending order, no sort in order every clicking the mouse.

4) Utilizable data list
Searched devices
Select the row to set the device.
The contents on the display can be scrolled with a mouse or keyboard.
Column width can be changed with a mouse.

5) Selected device
Position (device) where the cursor is positioned to in the utilizable data list
The selected device is displayed with the cursor by the keyboard.

6) Number of Utilizable data
Number of utilizable data displayed on the utilizable data list
The number of utilizable data displayed on the utilizable data list is changed with a scroll of the utilizable data list.

7) Display switching buttons

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
2)

8)

4)

9)

12)

5)
6)

1) 3)

7) 10)
11)
11 - 40 11. USEFUL FUNCTIONS
11.3 Setting Devices from Device Comments (Input Assist)



U
SE

FU
L 

FU
N

C
TI

O
N

S

11
Switches the targets to be displayed in the list.
The text on the center button indicates the type of the data displayed in the utilizable data list.

• [Device Comment]
• [Device Definition]
• [System Label]
• [Global Label]
• [OMRON NJ/NX Tag]
• [AB Native Tag]
• [Label (GT Designer3)]
• [OPC UA Tag]

The targets can be switched by using short cut keys ([Ctrl] + [←] or [Ctrl] + [→]).
8) [Device Comment / Device Definition List] button

Displays the [Device Comment / Device Definition List] dialog.
Import the device comment and the device definition.

➟6.1.6 ■4 [Device Comment / Device Definition List] dialog
9) [Global Label List] button

Displays the [Global Label List] dialog.
Import global labels.

➟6.1.4 ■7 [Global Label List] dialog
10) Tag list button

Displays one of the following dialogs according to the controller setting.
• [OMRON NJ/NX Tag List] dialog
• [AB Native Tag List] dialog
• [OPC UA Tag List] dialog

For the dialogs, refer to the following.
➟6.1.7 How to set OMRON NJ/NX tags

6.1.9 How to set AB native tags
6.1.10 How to set OPC UA tags

11) Setting button
Display the [Input Assist Setting] dialog.
Select available or unavailable for the input assist, or the search target.

➟11.3.4 [Input Assist Setting] dialog
12) Changing the window size

To change the size of the input assist window, move the mouse pointer to the lower right corner of the window where 
the pointer becomes a double-headed arrow, and drag the pointer.
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11.3.4 [Input Assist Setting] dialog

1) [Automatically display the input assist window]
Automatically displays the input assist window when a keyword is entered in the device entry field in the object 
setting dialog and others.
Even though this item is cleared, you can display the input assist window by the following operation.

2) [Show the device comment/definition/label settings], [Show the device comment/definition/
label/tag settings]
Displays the device comments, device definitions, and others as utilizable data in the input assist window.
Clear this item to display only the history of the device setting on the input assist window.

3) [Search Target]
Select the target for a search.
The following shows the items to be selected.

• [Label/Device Name and Comment/Definition] or [Device/Label/Tag Name and Comment/Definition]
• [Label/Device Name] or [Device/Label/Tag Name]
• [Comment/Definition]

4) [Sort]
Set the sorting order of the utilizable data list of the input assist window.
The following shows the items to be selected.

• [Label/Device Name] or [Device/Label/Tag Name]
• [Comment/Definition]
• [Remark]
• [None]

Up to three conditions for sorting order can be set and their priority is high from the top.
Select [Ascending] and [Descending] for each condition.

5) [Display Position Priority]
Select the display position of the input assist window against the device input field.
The following shows the items to be selected.

• [Bottom]
• [Top]
• [Right]
• [Left]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)
3)

4)

1)

5)

Click
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11.4 Utilizing Other Project Data

The settings for screens and functions can be read from a specified project (source) into the project (destination) being 
edited.
You can create a project efficiently by utilizing data of an existing project.

➟11.4.1 Specifications of the project utilization
11.4.2 How to use the project utilization
11.4.3 Precautions
11.4.4 [Utilize Project] dialog
11.4.6 [Select Project] dialog

11.4.1 Specifications of the project utilization

➟■1 Utilizable projects
■2 Utilizable data

■1 Utilizable projects

The following table lists the utilizable projects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Created project 2

Alarm 
Observation 1

Alarm 
Observation 2

Base screen 1 is utilized 
as base screen 10.

Alarm observation 1 is utilized 
with the number unchanged.

Destination project

Base screen 1

Alarm 
Observation 1

Base screen 10

Created project 1

Base screen 1

Base screen 2

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GOT Project format

GOT2000 Series
• Workspace format
• A single file format (*.GTX, *.GTXS)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Utilizable data

Select data to utilize from [Source Project] of the [Utilize Project] dialog.
➟11.4.4 [Utilize Project] dialog

The following table lists the utilizable data.

[Source Project] Utilizable data Supported 
model

[GOT Environmental 
Setting / GOT Setup / 
GOT Ethernet Setting]

[GOT Environmental Setting / 
GOT Setup]

Utilizes the following settings.
• [Environmental Setting] window (except the setting for [Operation Log])
• [GOT Setup] window
• [GOT Ethernet Setting] window

[CSP+ for iQSS Data Write] Utilizes the setting for [iQSS Utility] in the [GOT Setup] window.

[Operation Log]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Utilizes the setting for [Operation Log] in the [Environmental Setting] 
window.

[Network Drive] Utilizes the settings of [Network Drive] in the [GOT Setup] window.

[Controller Setting]

[Routing Information] Utilizes the setting for [Routing Information] in the [Controller Setting] 
window.

[Getaway Server] Utilizes the setting for [Getaway Server] in the [Controller Setting] window.

[Gateway Client] Utilizes the setting for [Gateway Client] in the [Controller Setting] window.

[Mail] Utilizes the setting for [Mail] in the [Controller Setting] window.

[FTP Server] Utilizes the setting for [FTP Server] in the [Controller Setting] window.

[File Transfer] Utilizes the setting for [File Transfer] in the [Controller Setting] window.

[MELSEC Redundant]

Utilizes the setting for [MELSEC Redundant] in the [Controller Setting] 
window. 
The MELSEC redundant setting is not migrated if the corresponding 
channel is not set in the destination project.

[Station No. Switching] Utilizes the setting for [Station No. Switching] in the [Controller Setting] 
window.

[Buffer Memory Unit No. 
Switching]

Utilizes the setting for [Buffer Memory Unit No. Switching] in the [Controller 
Setting] window.
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[Peripheral Setting]

[Bar Code]

Utilizes the setting for the [Bar Code] dialog (except the setting for 
[Destination I/F]). 
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[RFID]

Utilizes the setting for the [RFID] dialog (except the setting for [Destination 
I/F]). 
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[VNC Server]

Only available to GT2107-W for GT21.
Only available to GS21-W-N for GS21.
Utilizes the setting for the [VNC Server] dialog (except the setting for 
[Destination I/F]).
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[Video/RGB Input]

Utilizes the setting for the [Video/RGB Input] dialog (except the setting for 
[Destination I/F]). 
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[Multimedia]

Utilizes the setting for the [Multimedia] dialog (except the setting for 
[Destination I/F]). 
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[External I/O / Operation 
Panel]

Utilizes the setting for the [External I/O / Operation Panel] dialog (except 
the setting for [Destination I/F]). 
To utilize the setting for [Destination I/F], utilize [I/F Communication 
Setting].

[Printer]

Utilizes the settings of the [Printer] dialog (except the setting of [Destination 
I/F)]. 
To utilize the setting of [Destination I/F], utilize the settings of [I/F 
Communication Setting].

[GOT Network Interaction] Utilizes the setting of the [GOT Network Interaction] dialog.

[GOT Mobile Setting] Utilizes the setting of the [GOT Mobile Setting] window.

[I/F Communication Setting]

Utilizes the following settings.
• Interface setting for each channel

The same channel No. set for the source project is required to be 
enabled for the destination project.

• The setting for [Destination I/F] in the setting for each peripheral device

[Screen Design] Utilizes the setting of the [Screen Design] dialog.

[Base Screen]

Utilizes base screens. 
Screens to be utilized can be selected individually. 
The following settings for the screens to be utilized are also utilized.
• Screen trigger action
• Project script setting

A project script is utilized when [Include this script in a screen-related 
setting when utilizing project/screen] is selected in the [Script Edit] dialog.

• Screen script setting
• Script symbol
When utilized by the destination project, script data are associated with an 
existing script number + 1. 
To specify a script number to be used in utilization by the destination 
project, select [Script].

[Source Project] Utilizable data Supported 
model
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[Window Screen]

Utilizes window screens. 
Screens to be utilized can be selected individually. 
The following settings for the screens to be utilized are also utilized.
• Screen trigger action
• Project script setting

A project script is utilized when [Include this script in a screen-related 
setting when utilizing project/screen] is selected in the [Script Edit] dialog.

• Screen script setting
• Script symbol
When utilized by the destination project, script data are associated with an 
existing script number + 1. 
To specify a script number to be used in utilization by the destination 
project, select [Script].

[Report Screen]

Utilizes report screens.
Screens to be utilized can be selected individually.
If the following settings are configured for the report screen to be utilized, 
the destination report screen will be utilized together.
• [Output Destination] is set to [File].
• [Specification] is set to [Add to other report file].

[Mobile Screen] Utilizes mobile screens. 
Screens to be utilized can be selected individually.

[Label Group] Utilizes label groups. 
Label groups to be utilized can be selected individually.

[Comment] Utilizes comment groups. 
Comment groups to be utilized can be selected individually.

[Alarm]

[Alarm Common Setting] Utilizes the setting for the [Alarm Common Setting] dialog.

[User Alarm Observation] Utilizes the user alarm observation settings. 
User alarm observation settings to be utilized can be selected individually.

[System Alarm Observation] Utilizes the setting for the [System Alarm Observation] dialog.

[Alarm Popup Display] Utilizes the setting for the [Alarm Popup Display] dialog.

[Logging] Utilizes logging settings. 
Logging settings to be utilized can be selected individually.

[Recipe]

[Recipe Common Setting] Utilizes the setting for the [Recipe Common Setting] dialog.

[Recipe] Utilizes recipe settings. 
Recipe settings to be utilized can be selected individually.

[Source Project] Utilizable data Supported 
model
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[Script]

[Script (Project, Symbol)]

Utilizes the following settings.
• Project script setting
• Script symbol
The script of a utilized project script setting is executed after the script of 
an existing project script setting in the destination project is executed.

Registered script Utilizes scripts. 
Scripts to be utilized can be selected individually.

[Object Script Symbol] Utilizes the setting for the [Object Script Symbol] dialog.

[Device Data Transfer] Utilizes device data transfer settings. 
Device data transfer settings to be utilized can be selected individually.

[Trigger Action (Project)]
Utilizes the settings for the trigger actions commonly used in a project. 
To utilize the settings for the trigger actions of individual screens, utilize the 
screen for which the required trigger actions have been set.

[Time Action] Utilizes the setting for the time action.

[Hard Copy] Utilizes the setting for the [Hard Copy] dialog.

[MES Interface] Utilizes the settings of the [MESInterface] dialog.

[Parts]

[Parts Setting] Utilizes the setting for the [Parts Setting] dialog.

Registered parts Utilizes parts. 
Parts to be utilized can be selected individually.

[Sound Files]

[Touch Key Sound Setting] Utilizes the setting for the [Touch Key Sound Setting] dialog.

Registered sound files Utilizes sound files. 
Sound files to be utilized can be selected individually.

[Source Project] Utilizable data Supported 
model
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11.4.2 How to use the project utilization

Before utilizing another project
When the [Utilize Project] dialog is displayed while the following windows are open, the settings for the 
windows cannot be utilized.
• [Environmental Setting] window
• [GOT Setup] window
• [Controller Setting] window
Before displaying the [Utilize Project] dialog, close the above windows.

Step 1 Select [Project] → [Utilize Project] from the menu to display the [Utilize Project] dialog.

➟11.4.4 [Utilize Project] dialog
Step 2 Click the [Browse] button to display the [Open Project] dialog or [Select Project] dialog.

Switch the screens according to the format of the source project.
• Workspace format: Select in the [Select Project] dialog.
➟11.4.6 [Select Project] dialog

• A single file format: Select in the [Open Project] dialog.
➟2.3.2 ■5 [Open Project] dialog (single file format)

Step 3 In the [Open Project] dialog or [Select Project] dialog, select a source project and click the [Open] button.
The source project can be also set with the following methods
• In the [Utilize Project] dialog, click the [Search] button to display the [Utilize Data (Project)] dialog and search 

the source project.
• Enter the path to the [Source Project] and press the [Tab] key.
If project security has been set for the source project, the [User Authentication] dialog is displayed.
Enter a user name and the password.

Step 4 The path to the source project is set for [Source Project] in the [Utilize Project] dialog.
Select the settings to utilize in the [Source Project] tree.
When the following items are selected, the numbers set in [Destination] are enabled.
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen]
• [Label Group]
• [Comment]
• [User Alarm Observation]
• [Logging]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Switching to the [Open Project] dialog Switching to the [Select Project] dialog
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• [Recipe]
• [Script]
• [Device Data Transfer]
• [Parts]
• [Sound Files]
For the settings of the numbers used by the destination project, refer to the following.
➟■1 Utilizing settings without changing the numbers set in the source project
■2 Specifying a start number in utilizing settings for the source destination with their order and differences 

retained
■3 Specifying numbers setting by setting in utilization

Step 5 Click the [Utilize] button to read the selected settings into the destination project.
Step 6 If data in another project need utilizing, proceed to step 2.

When you have completed the utilization, close the [Utilize Project] dialog.

■1 Utilizing settings without changing the numbers set in the source project

The following shows the procedure for utilizing settings for a source project as those for a destination project without 
changing the associated numbers that have been set in the source project.

Step 1 In [Destination] of the [Utilize Project] dialog, select [Retain the same No.].
Example) Utilizing a base screen

Step 2 Click the [Utilize] button to read the settings selected in the [Source Project] tree into the destination project.
Step 3 When you have completed the utilization, close the [Utilize Project] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Specifying a start number in utilizing settings for the source destination with their order 
and differences retained

The following shows the procedure for specifying a start number in utilizing settings for a source project as those for a 
destination project with their order and differences retained.

Step 1 Select [Assign the first No.] in [Destination] of the [Utilize Project] dialog and set a start number.
Example) Utilizing a base screen

Step 2 Click the [Utilize] button to read the settings selected in the [Source Project] tree into the destination project.
Step 3 When you have completed the utilization, close the [Utilize Project] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Specifying numbers setting by setting in utilization

The following shows the procedure for specifying numbers setting by setting in utilization, which are used by the 
destination project.

Step 1 Select [Detail Setting] in [Destination] of the [Utilize Project] dialog and click the [...] button to display the 
[Detail Setting] dialog.
Example) Utilizing a base screen

Step 2 In [Destination], select the setting to utilize (in the row displaying the text in green).
Move the row you have selected with the [↑] or [↓] button into the row corresponding to the number used by 
the destination project.
Example) Utilizing a base screen of screen No.1 as that of screen No.5

➟11.4.5 [Detail Setting] dialog
Step 3 When you have completed the setting, click the [OK] button.
Step 4 Click the [Utilize] button in the [Utilize Project] dialog to read the settings selected in the [Source Project] tree 

into the destination project.
Step 5 When you have completed the utilization, close the [Utilize Project] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Move the selected row (the setting to utilize).
The base screen of screen No.1 is utilized 
as the base screen of screen No.5.
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11.4.3 Precautions

■1 Utilizing the project edited with a different version of GT Designer3
When the version of GT Designer3 being used is older than that used to edit the source project, the functions not supported 
by GT Designer3 being used are deleted.
For the relation between the version of GT Designer3 and supported functions, refer to the following.

➟12.17 Upgraded Additional Function List

■2 Utilizing the project protected with a security key
When the source project is protected with a security key, the security key authentication is performed.
If the authentication fails, the data cannot be utilized.

➟2.12 Protecting a Project with a Security Key

■3 Utilizing the project protected with the project security
If project security has been set for the source project, user authentication is performed.
Users for who display is disabled cannot utilize data.

■4 Utilizing the project containing a different GOT type setting
Utilized data are converted according to the GOT type set for the destination project.
The functions not supported by the GOT type set for the destination project are deleted.

■5 Utilizing the project containing different controller settings
Utilized data are converted according to the controller type set for the destination project.
According to the combination of the settings for the source project and those for the destination project, the devices set for 
utilized data are changed as described below.
• The devices are changed to the equivalents supported by the controller set for the destination project.
• The devices not supported by the controller set for the destination project are changed to [??] (except the devices in script 
data).

Check and change the device settings.

■6 Utilizing the project in which a system label is set
In the project being edited, when [Use system labels in conjunction with MELSOFT Navigator] of the [Type Setting] dialog 
is unchecked, the data of the screens from the project where a system label is set cannot be utilized.

➟5.1.5 [Type Setting] dialog

■7 Utilizing scripts
Even if the controller settings for the source project and destination project are different, the devices in script data are not 
automatically changed.
Check and change the device settings.

■8 Utilizing categories
Categories cannot be utilized.
When the categories set for figures and objects do not exist in the destination project, the categories are changed to [None] 
in utilization.
Before utilizing, add categories that exist in the source project into the destination project.

■9 Utilizing the project in which Windows fonts are used for comment groups
If the Windows fonts used for comment groups are not installed on the personal computer, the comments are displayed in 
different fonts.
To display the comments in the specified Windows fonts, make sure that the fonts are installed on the personal computer 
before utilizing the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.4.4 [Utilize Project] dialog

1) [Source Project]
Set the path to the source project.

2) [Select screen-related settings as well]
When items are selected in the [Source Project] tree, the relevant settings are also selected.
Example) If a base screen for which a screen script has been set is selected, the script is also selected.

3) [Source Project]
When a path is set for [Source Project], the utilizable source project settings are displayed in the tree structure.
Select the settings to utilize.

➟11.4.1 ■2 Utilizable data
The settings nonexistent in the source project or destination project are not displayed in the tree structure.
When the following items are selected, the related settings in [Destination] become available to specify numbers or 
utilization methods.

• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen]
• [Label Group]
• [Comment]
• [User Alarm Observation]
• [Logging]
• [Recipe]
• [Script]
• [Device Data Transfer]
• [MES Interface]

Item Description

[Browse] button

Displays the [Open Project] dialog or the [Select Project] dialog. 
Set the path to the source project.
➟11.4.6 [Select Project] dialog

　 2.3.2 ■5 [Open Project] dialog (single file format)

[Search] button
Displays the [Search] dialog. 
Searches projects that can be utilized.
➟11.1.4 [Utilize Data (Project)] dialog and [Search] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Parts]
• [Sound Files]

4) [Destination]
In each setting, specify a number to be used in the destination project or a utilization method.
The following shows selectable items.

• [Assign the first No.]
Specifies a start number in utilizing settings for the source project as those for the destination project with their 
order and differences retained.
Set a start number.
When a number falls out of the acceptable range, the setting associated with the number is not utilized.

Click the [Image] button of [Base], [Window], [Report], or [Mobile] to display the [Screen Image List] dialog.

If the start number set for [Label Group], [Comment Group], [User Alarm Observation], [Logging], [Recipe], or 
[Device Data Transfer] is used in the destination project, the name of the setting is displayed.
Example) If comment group No.1 has been used

• [Screen Type]
Select the type of the screen.

• Screen image list
Displays screen images.

• Jump
Specify a screen number and click the [Jump] button to select the 
screen in the screen image list.

Set a start number.
· [Base]: [0] to [32767]
· [Window]: [0] to [32767]
· [Report]: [1] to [99]

· [Label Group]: [1] to [200]
· [Mobile]: [1] to [32767]

· [Comment Group]: [1] to [500]
· [User Alarm Observation]: [1] to [32767]
· [Logging]: [1] to [32767]
· [Recipe]: [1] to [32767]
· [Script File List]: [1] to [32767]
· [Device Data Transfer]: [1] to [255]
· [Parts]: [1] to [32767]
· [Sound File]: [1] to [500]

Screen image list

Jump

The name of comment group No.1 is displayed.
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Click the [Image] button of [Parts] to display the [Image List] dialog.

Click the [Browse] button of [Sound File] to display the [Sound File List] dialog.
When the dialog is displayed from the [Utilize Project] dialog, sound files are not registered and deleted.
➟10.12.6 [Sound File List] dialog

• [Retain the same No.]
Utilize settings for the source project as those for the destination project without changing the associated 
numbers that have been set in the source project.

• [Detail Setting]
Specifies numbers setting by setting in utilization, which are used by the destination project.
Click the [...] button to display the [Detail Setting] dialog.
➟11.4.5 [Detail Setting] dialog

• [Add to the current setting]
Adds the settings that are unused in the destination project.

• [Overwrite all]
Overwrites all settings of the destination project with those of the source project.

• Parts image list
Display the images of parts.

• Jump
Set a part number and click the [Jump] button to display the images 
of the specified part on the parts image list.

Parts image list

Jump
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11.4.5 [Detail Setting] dialog

1) [From]
Lists the settings utilizable from the source project.

The text color of a setting represents the status of the setting.

For mouse and keyboard operations, refer to the following.
➟■1 Mouse and keyboard operations

2) [To]
Lists the settings in the destination project.

The text color of a setting represents the status of the setting.

Item Description

[No.] Number of each setting in the source project.

[Name] Name of each setting in the source project.

Text color Description

Black
Setting that is not added to [To].
To utilize a setting in the destination project, add the setting to [To] with the [→] button.

Gray Setting added to [To].

Item Description

[↑] button, [↓] button Moves the setting selected in [To] up or down.

[Show the existing 
screens only] Only displays the rows where a setting is present.

[No.] Number of each setting in the destination project.

[Name] Name of each setting in the destination project.

Text color Description

Black Setting existing in the destination project.

Blue Setting added from [From].

Red Duplicate setting number in the destination project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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The number of each setting in the destination project can be changed with the [↑] button or the [↓] button.
For mouse and keyboard operations, refer to the following.

➟■1 Mouse and keyboard operations
3) [→] button

Adds the setting selected in [From] to the row selected in [To].
If no row has been preselected in [To], the [Destination Data No. Specification] dialog appears.

4) [←] button
Deletes the setting selected in [To].

5) [Select All] button
Adds all the settings listed in [From] to [To].
The settings are added to the selected row and subsequent rows in [To].
If no row has been preselected in [To], each setting is added with its setting number unchanged.

6) [Deselect All] button
Deletes all the added settings from [To].

■1 Mouse and keyboard operations

The following shows operating [From] and [To] with a mouse and keyboard.

• [Destination Data No.]
Specify a setting number to be assigned in the destination project.
The setting range varies depending on the setting to be utilized.

Operation [From] [To]

Arrow (up, down) Moves the cursor.

[Shift] + Arrow (Up/Down)
Moves the row while selecting the row where the cursor 
is positioned 
The destination row of the cursor is also selected.

-

[Home] Moves the cursor to the top row.

[End] Moves the cursor to the bottom row.

[PageUp] Moves the cursor up one page.

[PageDown] Moves the cursor down one page.

[Shift] + [Home] Selects the rows from the row where the cursor is 
positioned to the top row. -

[Shift] + [End] Selects the rows from the row where the cursor is 
positioned to the bottom row. -

[Shift] + [PageUp]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves up one 
page.

-

[Shift] + [PageDown]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves down one 
page.

-

[Shift] + Click Selects the rows from the row where the cursor is 
positioned to the row where the mouse is clicked. -

[Ctrl] + [Space]
Selects or deselects a row.

Selects or deselects a row.

[Ctrl] + Click -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.4.6 [Select Project] dialog

1) [Save Folder Path]
Set the destination path to save the project.
The path can be set from the [Browse] button.

2) [Workspace/Project List]
The workspaces and projects in the path set in the [Save Folder Path] are displayed.
If a workspace is double-clicked, the projects in the workspace are displayed.

3) [Workspace Name]
Displays the workspace name selected in [Workspace/Project List].

4) [Project Path]
Displays the project name selected in [Workspace/Project List].
Up to 200 characters can be used for the total number of the characters of [Save Folder Path], [Workspace Name], 
and [Project Name].
"\" at the end of the project name is not counted as a character.

5) [Open single file format project] button
Switches the dialog to the [Open Project] dialog.

➟2.3.2 ■5 [Open Project] dialog (single file format)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.5 Verifying Project being Edited with Other Projects

The project being edited by GT Designer3 can be verified against another project and the difference can be checked.

Verification is available for the following projects.
• Projects stored in a personal computer
• Projects in the GOT

➟11.5.1 Specification of verification
11.5.2 How to use verification
11.5.3 Precautions
11.5.4 [Verify Project] dialog
11.5.5 [Verify Result] window
11.5.6 [Verify Result] dialog
11.5.7 Details of the exported file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Stored project

Project being edited

Verified

or

Projects in the GOT

The verification results are displayed.

[Verify Result] dialog

[Verify Result] window
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11.5.1 Specification of verification

➟■1 Verifiable projects
■2 Verification method

■1 Verifiable projects

➟(1) Verifying against a stored project in a personal computer
(2) Verifying against a project in the GOT

(1) Verifying against a stored project in a personal computer

The following shows the format of verifiable projects.

Verification is unavailable between the projects that specify different GOT types.
If the verification target is a project with a system application, the system application is not verified.

(2) Verifying against a project in the GOT

Verification against the GOT in the GOT2000 series is available in communication with it.
Verification is unavailable between the projects that specify different GOT types.

■2 Verification method

The following shows the methods of verifying a project.
• Data check
This method verifies settings.

• Time stamp check
This method verifies time stamps of files.
This method can be selected only for verifying against a project in GOT.

The following shows the verification target items of each method.
➟11.5.5 ■1 Verification items for data check
　 11.5.5 ■2 Verification items for time stamp check

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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GOT Project format

GOT2000 Series
• Workspace format
• A single file format (*.GTX, *.GTXS)
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GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.5.2 How to use verification

➟■1 Verifying against a stored project
■2 Verifying against the GOT

■1 Verifying against a stored project

Step 1 Perform one of the following operations to display the [Verify Project] dialog.

➟11.5.4 [Verify Project] dialog
• Select [Project] → [Verify Data] from the menu.
• In the [Verify Result] window, click the [Verify Project] button and select [Verify Project] from the pull-down 

menu.
Step 2 Set [Target Project] and click the [Verify] button.

If project security is set for the verification target, the [User Authentication] dialog is displayed.
Enter a user name and the password.
If different versions of GT Desiger3 are used for the project being edited and the verification target project, a 
dialog appears, confirming that a verification is executed according to the version of GT Designer3 used for the 
project being edited.
Click [Yes] button to execute the verification.

Step 3 The [Verify Result] window displays the verification results.
In the [Verify Result] window, double-click a verification result to display the corresponding figure, object, or 
setting dialog.
➟11.5.5 [Verify Result] window

■2 Verifying against the GOT

For how to verify the project being edited against a project in GOT, refer to the following.
➟4.3.2 ■4 Verifying projects between the GOT and GT Designer3

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.5.3 Precautions

■1 Verifying against a project protected with a security key
When the verification target project is protected with a security key, the security key authentication is performed.
If the authentication fails, verifying the project is not available.

➟2.12 Protecting a Project with a Security Key

■2 Verifying against a project for which project security has been set.
If security is set for the verification target project, user authentication is performed.
If display-disabled screens or scripts exist in the project being edited or the verification target project, verification of the 
project is unavailable.

■3 Verifying against a project edited by GT Designer3 of another version
If the version of GT Designer3 used to edit the verification target project and that being used for the project being edited are 
different, the verification results may be different from those obtained when the version is the same.

■4 Verifying the current project against the project stored in the GOT after writing package 
data to multiple GOTs in one go

When you write package data to multiple GOTs in one go, the individual identification information and the communication 
interface setting data are not written.
Accordingly, inconsistencies in the following settings may be detected as a result of the verification.

• [Individual Identification Information]
• [Controller Setting (I/F Communication Setting)]

11.5.4 [Verify Project] dialog

1) [Target Project]
Set the project being edited and the verification target project.
The path can be set from the [Browse] button.

2) [Verify] button
Starts verification and displays the [Verify Result] window.
The verification results can be checked.

➟11.5.5 [Verify Result] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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11.5.5 [Verify Result] window

1) [Verify Project] button
Select an item from the pull-down menu to start a verification.

2) [Option] button
Select an item from the pull-down menu to operate the [Verify Result] window.

3) [Range]
Narrow the displayed contents of the verification results by selecting a verification item.
The following shows selectable items.

• [All]
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Common settings]

4) [Display Items]
Narrow the displayed contents of the verification results by selecting the type of differences.
The following shows selectable items.

• [All]
• [Data with differences]
• [Data that exists in the source only]
• [Data that exists in the destination only]
• [Mismatched data]

5) Verification results
Displays the results of verification.

Item Description

[Verify Project] Verifies the project being edited against a project saved in the personal computer.

[Verify GOT]
Displays the [GOT Verification] tab of the [Communicate with GOT] dialog.

➟4.8.2 ■3 [GOT Verification] tab
In the dialog, verify the project being edited against a project saved in the GOT.

Item Description

[Export] button
Saves the verification results as a Unicode text file. 
Set [File name] and click the [Save] button in the displayed dialog.

➟11.5.7 Details of the exported file

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

5)

3)1) 4)2)

6)

7)
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In each row, the target item for verification is shown.
The item that has been set for neither the project being edited nor the verification target project is not displayed.
The verified items differ depending on the verification method.
(For the verification against a project stored in a personal computer, the verification method available is only the data 
check.)

➟■1 Verification items for data check
■2 Verification items for time stamp check

The background color of a row varies according to the type of a difference.
• Blue: The item exists only in the verification source project.
• Green: The item exists only in the verification target project.
• Red: The item exists in both projects and the data are not matched.

Double-click an item in the verification source project to select the corresponding object or others, or display the 
corresponding dialog.
For the behavior of double-clicking an item, refer to the following.

➟■1 Verification items for data check
Right-click a row and select [Open the Setting dialog] from the menu to display the corresponding setting dialog.
This function is not available to the row indicating an order mismatch and the data existing only in the verification target 
project.
The verification results are retained even if you close the [Verify Result] window.
To delete the verification results, close the project or convert the GOT type set in the project.

6) Number of differences
This item appears when any difference exists.
When the verification method is set to the data check, the item (screen number or title) immediately below the [Base 
Screen], [Window Screen], [Report Screen], or [Mobile Screen] row is not counted.

7) [About Result] button
Displays Help.

Item Description

[Source Project] Displays the information of the project being edited.

[Destination Project] Displays the information of the verification target project.

[Compare Result] Displays the presence/absence and the type of differences.
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■1 Verification items for data check

The following shows the items to be verified by the data check.
In the [Verify Result] window, double-clicking an item in the verification source project selects the corresponding object or 
others, or displays the corresponding dialog.

(1) [Screen Design]

Double-click this item to display the [Screen Design] dialog.

(2) [Base Screen]
Verifies the base screens that exist in a project by screen No.
Also verifies the following items set in each screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Item] Remarks Supported 
models

[Screen Property] Double-clicking this item displays the corresponding screen 
and the [Screen Property] dialog.

[Screen Script] Double-clicking this item displays the [Screen] tab of the 
[Script] dialog.

[Screen Trigger Action] Double-clicking this item displays the [Screen] tab of the 
[Trigger Action] dialog.

Figure/object type name (Object ID) (Name)

The figures or objects having the same object ID are verified.
The figure IDs are controlled internally and cannot be checked.
When you cut or copy a figure and then paste it to the location 
where the original figure has been placed, if the original and 
pasted figures have different IDs, the figures are handled as 
different data.
The name appears when it is set for a figure or object.
Double-clicking this item selects the corresponding figure or 
object on the screen editor.

[(Unmatched figure/object stacking order)]

The placement orders of figures or objects, and the states of 
grouping are verified.
This item appears when the numbers of placed figures or 
objects are the same.
The verification starts from the rearmost figure or object. 
Double-clicking this item selects a figure or object in which the 
first placement order difference is detected.
When the placement order of a figure or object is directly 
changed, double-clicking this item may select any figure or 
object whose placement order is affected by the change.
The placement order also differs when figures or objects are 
grouped.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(3) [Window Screen]
Verifies the window screens that exist in a project by screen No.
Also verifies the following items set in each screen.

(4) [Report Screen]
Verifies the report screens that exist in a project by screen No.
Also verifies the following items set in each screen.

[Item] Remarks Supported 
models

[Screen Property] Double-clicking this item displays the corresponding screen 
and the [Screen Property] dialog.

[Screen Script] Double-clicking this item displays the [Screen] tab of the 
[Script] dialog.

[Screen Trigger Action] Double-clicking this item displays the [Screen] tab of the 
[Trigger Action] dialog.

Figure/object type name (Object ID) (Name)

The figures or objects having the same object ID are verified.
The figure IDs are controlled internally and cannot be checked.
When you cut or copy a figure and then paste it to the location 
where the original figure has been placed, if the original and 
pasted figures have different IDs, the figures are handled as 
different data.
The name appears when it is set for a figure or object.
Double-clicking this item selects the corresponding figure or 
object on the screen editor.

[(Unmatched figure/object stacking order)]

The placement orders of figures or objects, and the states of 
grouping are verified.
This item appears when the numbers of placed figures or 
objects are the same.
The verification starts from the rearmost figure or object. 
Double-clicking this item selects a figure or object in which the 
first placement order difference is detected.
When the placement order of a figure or object is directly 
changed, double-clicking this item may select any figure or 
object whose placement order is affected by the change.
The placement order also differs when figures or objects are 
grouped.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

[Item] Remarks Supported 
models

[Report Setting] Double-clicking this item displays the [Report Setting] dialog.

[Screen Property] Double-clicking this item displays the corresponding screen 
and the [Screen Property] dialog.

Figure/object type name (Object ID) (Name)

The figures or objects having the same object ID are verified.
The figure IDs are controlled internally and cannot be checked.
When you cut or copy a figure and then paste it to the location 
where the original figure has been placed, if the original and 
pasted figures have different IDs, the figures are handled as 
different data.
The name appears when it is set for a figure or object.
Double-clicking this item selects the corresponding figure or 
object on the screen editor.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(5) [Mobile Screen]
Verifies the mobile screens that exist in a project by screen No.
Also verifies the following items set in each screen.

(6) [Common]

[Item] Remarks Supported 
models

[Screen Property] Double-clicking this item displays the corresponding screen 
and the [Screen Property] dialog.

Figure/object type name (Object ID) (Name)

The figures or objects having the same object ID are verified.
The figure IDs are controlled internally and cannot be checked.
When you cut or copy a figure and then paste it to the location 
where the original figure has been placed, if the original and 
pasted figures have different IDs, the figures are handled as 
different data.
The name appears when it is set for a figure or object.
Double-clicking this item selects the corresponding figure or 
object on the screen editor.

[(Unmatched figure/object stacking order)]

The placement orders of figures or objects, and the states of 
grouping are verified.
This item appears when the numbers of placed figures or 
objects are the same.
The verification starts from the rearmost figure or object. 
Double-clicking this item selects a figure or object in which the 
first placement order difference is detected.
When the placement order of a figure or object is directly 
changed, double-clicking this item may select any figure or 
object whose placement order is affected by the change.
The placement order also differs when figures or objects are 
grouped.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

[Item] Remarks Supported 
models

[GOT Type Setting] Double-clicking this item displays the [Type Setting] dialog.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[GOT Environmental Setting]

[Screen Switching/Windows]

Double-clicking this item displays the corresponding setting 
screen of the [Environmental Setting] window.

[Language Switching]

[Dialog window]

[Key Window]

[System Information]

[Security]

[Operation Log]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

[Internal Device Retention]

(Except 
GT2103-P)

[Kana-Kanji/Pinyin Conversion]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

[Startup Logo]

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[GOT Setup]

[Display Setting/Language 
Setting]

Double-clicking this item displays the corresponding setting 
screen of the [GOT Setup] window.

[GOT ID No]

[Operation Setting/Utility Call Key]

[USB Host]
(Except 
GT25HS-V)
(Only available 
to GT2107-W 
for GT21)

[Time Setting]

[Transparent Mode Setting]

[GOT Internal Device Monitor]

[SoftGOT-GOT Link]

[VNC Server]
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

[Sequence Program Monitor]

[Backup/Restoration] (Only available 
to GT 
SoftGOT2000 
(Multiple 
channels) for 
GT 
SoftGOT2000)

[Wireless LAN Setting]

(Except 
GT2505-V and 
GT25HS-V)

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[GOT Setup]

[System Launcher]

Double-clicking this item displays the corresponding setting 
screen of the [GOT Setup] window.[iQSS Utility]

[CSP+ for iQSS Data Write]

[Controller Setting (I/F Communication Setting)] Double-clicking this item displays the [I/F Communication 
Setting] dialog.

[Controller Setting] Double-clicking this item displays the [Controller Setting] 
window.

[Ethernet Setting]

Double-clicking this item displays the [Controller Setting] 
window.
Even when a setting difference is detected in any of the 
channels, the CH1 setting screen appears.

[Network/Duplex Setting]

[Routing Information]

Double-clicking this item displays the corresponding setting 
screen of the [Controller Setting] window.

[Getaway Server]

[Getaway Client]

[Mail]

[FTP Server]

[File Transfer]

[MELSEC Redundant]

[Station No. Switching]

[Buffer Memory Unit No. Switching] Double-clicking this item displays the [Buffer Memory Unit No. 
Switching] setting screen of the [Controller Setting] window.

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Peripheral Setting] 
(excluding destination I/F)

[Bar Code] Double-clicking this item displays the [Bar Code] dialog.

[RFID] Double-clicking this item displays the [RFID] dialog.

[PC Remote Operation] Double-clicking this item displays the [PC Remote Operation] 
dialog.

[VNC Server] Double-clicking this item displays the [VNC Server] dialog.
(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

[Video/RGB Input] Double-clicking this item displays the [Video/RGB Input] 
dialog.

[Multimedia] Double-clicking this item displays the [Multimedia] dialog.

[External I/O / Operation Panel] Double-clicking this item displays the [External I/O / Operation 
Panel] dialog.

(Except GT25-
W, GT2505-V, 
and GT25HS-
V)

[Printer] Double-clicking this item displays the [Printer] dialog.

(Except 
GT2105-Q)

[GOT Network Interaction] Double-clicking this item displays the [GOT Network 
Interaction] dialog.

[GOT Mobile Setting] Double-clicking this item displays the [GOT Mobile Setting] 
window.

[Label] (label (GT Designer3))
The data is verified by label group No.
Double-clicking this item displays the [Label Group] window for 
the corresponding label group.

[Comment]
The data is verified by comment group No.
Double-clicking this item displays the [Comment List] window 
for the corresponding comment group.

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Alarm]

[Alarm Common Setting] Double-clicking this item displays the [Alarm Common Setting] 
dialog.

[User Alarm Observation]
The data is verified by alarm ID.
Double-clicking this item displays the [User Alarm 
Observation] dialog for the corresponding alarm ID.

[System Alarm Observation] Double-clicking this item displays the [System Alarm 
Observation] dialog.

[Alarm Popup Display] Double-clicking this item displays the [Alarm Popup Display] 
dialog.

[Logging]
The data is verified by logging ID.
Double-clicking this item displays the [Logging] dialog for the 
corresponding logging ID.

[Recipe]

[Recipe Common Setting] Double-clicking this item displays the [Recipe Common 
Setting] dialog.

[Recipe]
The data is verified by recipe No.
Double-clicking this item displays the [Recipe] dialog for the 
corresponding recipe No.

[Device Data Transfer]
The data is verified by device data transfer ID.
Double-clicking this item displays the [Device Data Transfer] 
dialog for the corresponding device data transfer ID.

[Trigger Action] Double-clicking this item displays the [Project] tab of the 
[Trigger Action] dialog.

[Time Action] Double-clicking this item displays the [Time Action List] dialog.

[Hard Copy] Double-clicking this item displays the [Hard Copy] dialog.

[Script]

[Script] Double-clicking this item displays the [Project] tab of the 
[Script] dialog.

[Script Text] Double-clicking this item displays the [Script File List] dialog.

[Object Script Symbol] Double-clicking this item displays the [Object Script Symbol] 
dialog.

[MES Interface] Double-clicking this item displays the [MES Interface] dialog.

[Application Setting] Double-clicking this item displays the [System Application] tab 
of the [Application Selection] dialog.

[Parts]

[Parts Setting] Double-clicking this item displays the [Parts Setting] dialog.

[Parts]
The data is verified by registered part.
Double-clicking this item displays the parts editor for the 
corresponding part.

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
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GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23
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(7) [Individual Identification Information]

The following pieces of information are included in the individual identification information.
• [GOT ID]
• [GOT Net No.]
• [GOT Station]
• [GOT IP Address]
• [Subnet Mask]
• [Default Gateway]
• [Peripheral S/W Communication Port No.]
• [Transparent Port No.]
• [IP Filter Setting]
• [Restrict write from GT Designer3 of the older versions]
Double-clicking this item displays the [I/F Communication Setting] dialog.

(8) [Communication Settings with GOT / IP List]

Double-clicking this item displays the [Communication Configuration] dialog.

(9) [System Label]

Displaying the setting dialog by double-clicking is not available.

■2 Verification items for time stamp check

The following shows the items to be verified by the time stamp check.
The time stamp check does not support displaying a setting dialog from a verification result.

[Sound Files]

[Touch Key Sound Setting] Double-clicking this item displays the [Touch Key Sound 
Setting] dialog.

(Except 
GT2505-V and 
GT25HS-V)

[Sound Files]
The data is verified by registered sound file.
Double-clicking this item displays the [Sound File List] dialog.

[Project information]

The latest update date and the edit version history are not 
included in the verification targets.
Double-clicking this item displays the [Project information] 
dialog.

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

[Item] Remarks Supported 
models

[Base Screen] Verifies the base screens that exist in a project by screen No.

[Window Screen] Verifies the window screens that exist in a project by screen 
No.

[Report Screen] Verifies the report screens that exist in a project by screen No.

[Mobile Screen] Verifies the mobile screens that exist in a project by screen No.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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[Common]

The following settings are also verified.
• [Project information]

Except the last update date and the edit history.
• [Screen Design]

[Startup Logo] -

[GOT Setup] If [Connection Type] is set to [Ethernet] in the [Printer] dialog, 
the printer settings are verified.

[Controller Setting (I/F Communication Setting)] -

[Ethernet Setting] -

[Label] (label (GT Designer3)) The data is verified by label group No.

[Comment] The data is verified by comment group No.

[Recipe]

[Recipe Common Setting] -

[Recipe] The data is verified by recipe No.

[Device Data Transfer] -

[MES Interface] -

[Application Setting] -

[Parts] -

[Sound] -

[Individual Identification Information] -

[Communication Settings with GOT / IP List] -

[System Label] -

[Label] (label (GT Designer3)) -

[Item] Remarks Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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SoftGOT2000
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11.5.6 [Verify Result] dialog

1) [Range]
Narrow the displayed contents of the verification results by selecting a verification item.
The following shows selectable items.

• [All]
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, and GS25)
• [Common settings]

2) [Display Items]
Narrow the displayed contents of the verification results by selecting the type of differences.
The following shows selectable items.

• [All]
• [Data with differences]
• [Data that exists in the source only]
• [Data that exists in the destination only]
• [Mismatched data]

3) Verification results
Displays the results of verification.
In each row, the target item for verification is shown.
The item that has been set for neither the project being edited nor the verification target project is not displayed.
The verified items differ depending on the verification method.
(For the verification against a project stored in a personal computer, the verification method available is only the data 
check.)

➟11.5.5 ■1 Verification items for data check
11.5.5 ■2 Verification items for time stamp check

The background color of a row varies according to the type of a difference.
• Blue: The item exists only in the verification source project.
• Green: The item exists only in the verification target project.
• Red: The item has a difference in its data.

Item Description

[Source project data] Displays the information of the project being edited.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4) Number of differences
This item appears when any difference exists.
When the verification method is set to the data check, the item (screen number or title) immediately below the [Base 
Screen], [Window Screen], [Report Screen], or [Mobile Screen] row is not counted.

5) [About Result] button
Displays Help.

6) [Output to Verify Result (window)] button
This item appears only when the verification method is set to the data check.
Displays the verification results in the [Verify Result] window.
The settings of [Range] and [Display Items] are retained.
Even if the [Verify Result] dialog is closed, you can check the verification results.

➟11.5.5 [Verify Result] window
7) [Export] button

Saves the verification results as a Unicode text file.
Set [File name] and click the [Save] button in the displayed dialog.

➟11.5.7 Details of the exported file

11.5.7 Details of the exported file

The following shows the details of the exported file of verification results.

1) [Source project data]
Displays the information of the project being edited.
In each row, the target item for verification is shown.

➟11.5.1 ■2 Verification method
2) [Destination project data]

Displays the information of the verification target project.
In each row, the target item for verification is shown.

➟11.5.1 ■2 Verification method
3) Types of differences

Displays the types of differences.
• [L]: The item exists only in the verification source project.
• [R]: The item exists only in the verification target project.
• [D]: The item has a difference in its data.

[Destination project data] Displays the information of the verification target project.

[Compare Result] Displays the presence/absence and the type of differences.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.6 Efficient Drawing with Templates

Templates are the combination of the following group and information.
• Group of the figures and objects on the screen editor
• The attribute information for the above group (template attribute)

For the attributes registered into template attributes, the set values can be batch changed.
Because the attributes of figures and object do not need changing separately, drawing data can be utilized efficiently.
• Batch changing successive devices by changing the first device with the difference between any two of successive device 
numbers retained
Example) Changing the first device of the device range (X0000 to X0003) of a template attribute to X1000

• Batch changing the color
Example) Changing the lamp color of a template attribute from green into red

If created templates are registered in the library, they can be utilized in creating another screen.
➟11.6.1 Specifications of the template
11.6.2 How to use the template
11.6.3 Precautions
11.6.4 [Edit Template Attribute] dialog
11.6.5 [Register to Template] dialog
11.6.6 [Property] window (when the template property is displayed)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Group of the figures and objects Template Attribute

Monitor Device (Attribute type: Bit)

X0000 (Device of bit lamp 1)
X0001 (Device of bit lamp 2)
X0002 (Device of bit lamp 3)
X0003 (Device of bit lamp 4)

Color of lamp off status (Attribute type: Color)

Green (shape color of bit lamp 1)
Green (shape color of bit lamp 2)
Green (shape color of bit lamp 3)
Green (shape color of bit lamp 4)

Template

Registering 
attribute

Registering 
attribute

Bit lamp 1
Device: X0000
Color of off status 
shape: Green

Bit lamp 2
Device: X0001
Color of off status 
shape: Green

Bit lamp 3
Device: X0002
Color of off status 
shape: Green

Bit lamp 4
Device: X0003
Color of off status 
shape: Green

The difference between any two of 
successive device numbers is retained.

Monitor Device (Type: Bit)

X0000 (Device of bit lamp 1)
X0001 (Device of bit lamp 2)
X0002 (Device of bit lamp 3)
X0003 (Device of bit lamp 4)

Monitor Device (Type: Bit)

X1000 (Device of bit lamp 1)
X1001 (Device of bit lamp 2)
X1002 (Device of bit lamp 3)
X1003 (Device of bit lamp 4)

The colors of all the lamps are changed to red.

Color of lamp off status (Attribute type: Color)

Green (shape color of bit lamp 1)
Green (shape color of bit lamp 2)
Green (shape color of bit lamp 3)
Green (shape color of bit lamp 4)

Color of lamp off status (Attribute type: Color)

Red (shape color of bit lamp 1)
Red (shape color of bit lamp 2)
Red (shape color of bit lamp 3)
Red (shape color of bit lamp 4)
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11.6.1 Specifications of the template

➟■1 Figures and objects that can be registered in a template
■2 Template attributes and the types of attributes that can be registered
■3 Displaying templates on the screen editor

■1 Figures and objects that can be registered in a template

The figures and objects on the same screen editor can be registered in a template.
Figures and objects that have been registered in a template cannot be registered in another template.

■2 Template attributes and the types of attributes that can be registered

Up to 255 template attributes can be possessed by a single template.
The following shows the types of the attributes that can be registered as template attributes.
• Bit (device)
• Word (device)
• Numerical value
• Character string
• Color
• Figure
• Font
• Text size

■3 Displaying templates on the screen editor

When a template is placed on the screen editor, a template information box that indicates the existence of the template is 
shown.

The template information box displays the template's name.
The information boxes can be used to rearrange the figures and objects registered in the template and to open the editor 
screen for the template.

(1) Displaying template information boxes
Template information boxes are displayed only on the screen editor of GT Designer3.
The boxes are not displayed in the [Screen Preview] window and [Data View] window of GT Designer3, and on the GOT 
display screen.

(2) Display settings for template information boxes
Display/hide template information boxes and change their background colors in the [View] tab of the [Options] tab.
The text of the template name is displayed in the color set for [Device/Object ID Text Color].

➟11.10.5 ■1 [Options] dialog ([View] tab)

(3) Operations on template information boxes
• Template information boxes can be moved as in the case of figures and objects.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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To move a template information box simultaneously with registered figures and objects, select them together.
When a template information box is double-clicked, all the registered figures and objects are selected.

• When a copy and paste, replication, and consecutive copy operation are performed on a template information box, the 
registered figures and objects are also processed.

• Rotation, reversing, and part registration cannot be performed.

11.6.2 How to use the template

➟■1 Creating screens using templates
■2 Creating and editing templates
■3 Registering templates at the library
■4 Canceling template settings

■1 Creating screens using templates

➟(1) Before utilizing templates
(2) Utilizing templates of the library
(3) Checking the attributes of the figures and objects in templates
(4) Batch changing the set values for attributes
(5) Changing by attribute

(1) Before utilizing templates

Certain templates require settings necessary for the project in which the templates are utilized, such as the controller 
setting and Go To Screen switch setting.
Check the settings of the template to be utilized and set necessary items for the project.
The following shows the required settings for the project in which templates are utilized.

(a) Controller setting
Before pasting templates, set the items in the [Controller Setting] dialog.

➟5.5.1 ■4 [Controller Setting]
If the settings for a pasted template are not supported by the set controller, the device settings are changed as described 
below.

• The devices are changed to the equivalents supported by the controller.
• The devices not supported by the set controller (because the equivalents do not exist or they are outside the 

acceptable setting range) are changed to [??].
When setting a controller that does not support the settings for the template, check and change the device settings.

(b) Common setting
When utilizing templates in which user alarm displays and historical trend graphs are used, set necessary common setting 
items, such as user alarm observation and logging.

(c) Go To Screen switch setting
After pasting on a base screen a template in which a Go To Screen switch is placed, check and change [Screen No.] of the 
switch in consideration of the base screen No.

➟8.2.7 ■1 [Next Screen] tab

(2) Utilizing templates of the library

Step 1 Select [View] → [Docking Window] → [Library List], [Library List (Template)] from the menu to display the 
[Library] window.

Step 2 Click the template to utilize, in the [Library] window.

➟8.1.4 [Library] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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In My Library, you cannot check if the library data include the template.
Paste the template on the screen editor to check if the template information box is displayed.
➟11.6.1 ■3 Displaying templates on the screen editor

Step 3 Click the screen editor to paste the template.
To change the sizes or positions of individual figures and objects, cancel the grouping.
Even if the grouping is canceled, the registration of the figures and objects in the template is not canceled.

For certain templates, the [Select CH No.] dialog is displayed when the templates are pasted.

Select the channel of the controller to monitor.
The controller devices that have been set for the template are changed as described below according to the 
controller on the selected channel.
• The devices are changed to the equivalents supported by the controller on the selected channel.
• The devices not supported by the controller on the selected channel (because the equivalents do not exist or 

they are outside the acceptable setting range) are changed to [??].
When selecting the channel of a controller that does not support the settings for the template, check and change 
the device settings.
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(3) Checking the attributes of the figures and objects in templates

The following procedure shows how to check the set values for the attributes of the figures and objects in a template.
Step 1 When carrying out one of the following operations, the details of the settings for the template are displayed 

in the [Property] window.
• Double-click the template information box on the screen editor or in the [Data Browser] window.
• Right-click the template information box on the screen editor and select [Display Template Property] from the 

menu.
• On the screen editor or in the [Data Browser] window, select a figure or object that has been registered in the 

template and click the [Template Property] button displayed in the [Property] window.
Step 2 Check the set values for attributes in the [Property] window.

➟11.6.6 [Property] window (when the template property is displayed)

For the procedure for changing the set values, refer to the following.
➟(4) Batch changing the set values for attributes
(5) Changing by attribute

(4) Batch changing the set values for attributes

The following shows the procedure for changing the set values for attributes in the [Property] window.
Example) When the template attribute is "Bit" and the same device is set for multiple registered attributes

Step 1 Display the details of the template with the [Property] window.

➟(3) Checking the attributes of the figures and objects in templates
Step 2 Change the set value for the attribute in the target template attribute row.

Step 3 The set values for the registered attributes in the template attribute are changed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Change the start device from X0000 to X1000.
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When a setting falls out of the input range as a result of the batch change, it causes an error.
If a set value falls out of the input range, the set values in the corresponding figure/object attribute row and the 
successive rows below are not changed.

The following describes the specifications of the batch change for each attribute.

(a) Bit, word
By changing the start device of the set values for attributes, the set values for the attributes below the start device can be 
batch changed. The difference between any two of successive device numbers is not changed.

Devices' names can be also batch changed.

Batch change is enabled when the following conditions are satisfied.
• Devices that have the same channel No., network No., station No., CPU No., and block No. are set for all the 

attributes.
• Devices that have the same name are set for all the attributes.

Even if the data types of the attributes are different, batch change is enabled.
To change the set values for all the attributes to the same device, change the set values for the attributes individually.

➟(5) Changing by attribute

(b) Numerical value
By changing the smallest of the set values for the attributes, the set values for the attributes can be batch changed. The 
difference between any two of successive set values is not changed.

The set value for each attribute is changed according to the start device.

Before

The set values are changed but the difference 
between any two of successive device numbers 
is not changed.

Template Attribute

X0000

X0001

Set value

X001F

… Change the start device 
from X0000 to X1000.

Bit lamp

Bit lamp

Bit lamp

…

Monitor device X0000 to X001F

After
Template Attribute

X1000

X1001

Set value

X101F

…

Bit lamp

Bit lamp

Bit lamp

…

Monitor device X1000 to X101F

Before

The device name is changed.

Template Attribute

X0000

X0001

Set value

X001F

… Change the start device's 
name from X to Y.

Bit lamp

Bit lamp

Bit lamp

…

Monitor device X0000 to X001F

After
Template Attribute

Y0000

Y0001

Set value

Y001F

…

Bit lamp

Bit lamp

Bit lamp

…

Monitor device Y0000 to Y001F
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To change the set values for all the attributes to the same value, change the set values for the attributes individually.
➟(5) Changing by attribute

(c) Character string
The set values for all the attributes can be batch changed to the same character string.

The maximum number of characters that can be typed in a single template attribute row is the same as the upper limit of 
the widest of all the acceptable input ranges for the registered attributes.
However, the maximum number of characters for each attribute is within the acceptable input range for each attribute.

(d) Color
The set values for all the attributes can be batch changed to the same color.

For the following attributes, different ways of setting colors are had. Hence if the attributes are mixed in the same template 
attribute, the colors are not batch changed.

• Text color of switches and lamps
• Color of the switches with their figures from the system library (color switching)
• Color of logo texts (color fill effect)

(e) Figures, fonts, text sizes
The set values for all the attributes can be batch changed to the same.
Example) When the type is text size

Before

The set values are changed but the difference 
between any two of successive set values 
is not changed.

Template Attribute

1

10

Set value

60

… Change the smallest value 
from 1 to 100.

Go To Screen switch

Go To Screen switch

Go To Screen switch
…

Screen No. 1 to 60

After
Template Attribute

100

109

Set value

159

…

Go To Screen switch

Go To Screen switch

Go To Screen switch

…

Screen No. 100 to 159

Before

The set values of all the attributes are changed.

Template Attribute

Switch 1

Switch 2

Set value

Switch 10

… Type SWITCH as a set value 
in the template attribute row.

Bit Switch

Bit Switch

Bit Switch

…

Switch name

After
Template Attribute

SWITCH

SWITCH

Set value

SWITCH

…

Bit Switch

Bit Switch

Bit Switch

…

Switch name SWITCH

Before

The set values of all the attributes are changed.

Template Attribute

Red

Red

Set value

Red

… Change the set value 
for the template attribute row 
from red to blue.

Go To Screen switch

Go To Screen switch

Go To Screen switch

…

Off color (each screen) Red

After
Template Attribute

Blue

Blue

Set value

Blue

…

Go To Screen switch

Go To Screen switch

Go To Screen switch

…

Off color (each screen) Blue
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If the acceptable setting range for each attribute is the same, the sizes are batch changed.

(5) Changing by attribute

Step 1 Display the details of the template with the [Property] window.

➟(3) Checking the attributes of the figures and objects in templates
Step 2 When the setting in a figure/object attribute row is changed, the set value for the attribute is changed.

If the model is a figure, the set value can be changed in the [Image List] dialog.
➟6.4.2 Color settings

■2 Creating and editing templates

➟(1) Creating templates and registering figures and objects into the templates
(2) Registering figures and objects into an existing template.
(3) Deleting figures and objects from a template
(4) Creating template attributes
(5) Deleting template attributes
(6) Registering attributes into template attributes
(7) Deleting attributes from the template attributes

(1) Creating templates and registering figures and objects into the templates

Step 1 On the screen editor, select the figure or object to register in a template.
Step 2 Either of the following operations displays the [Register To Template] dialog.

• Select [Edit] → [Template Registration] → [Register to Template] from the menu.
• Right-click the figure or object and select [Template Registration] → [Register to Template] from the menu.

Step 3 Select [New] and set [New Template Name].

Before

The set values of all the attributes are changed.

Template Attribute

0.5×0.5 (width × length)

1×1 (width × length)

Set value

6×6 (width × length)

…

Change the set value 
for the template attribute row 
to 2×2 (width × length).

Bit Switch

Bit Switch

Bit Switch

…

Text size

After
Template Attribute

2×2 (width × length)

2×2 (width × length)

Set value

2×2 (width × length)

…

Bit Switch

Bit Switch

Bit Switch

…

Text size 2×2 (width × length)
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Step 4 Click the [OK] button to display the [Edit Template Attribute] dialog.

➟11.6.4 [Edit Template Attribute] dialog
Step 5 Edit the template attribute then click the [OK] button to complete registering into the template.

When a new template is created, template attributes are displayed on the screen editor.
For the procedure for editing template attributes in the [Edit Template Attribute] dialog, refer to the following.
➟(4) Creating template attributes
(5) Deleting template attributes
(6) Registering attributes into template attributes
(7) Deleting attributes from the template attributes

(2) Registering figures and objects into an existing template.

Step 1 On the screen editor, select the figure or object to register in a template.
Step 2 Either of the following operations displays the [Register To Template] dialog.

• Select [Edit] → [Template Registration] → [Register to Template] from the menu.
• Right-click the figure or object and select [Template Registration] → [Register to Template] from the menu.

Step 3 Select [Add] then select the target template for registering.

Step 4 Click the [OK] button to display the [Edit Template Attribute] dialog.

➟11.6.4 [Edit Template Attribute] dialog
Step 5 Edit the template attribute then click the [OK] button to complete registering into the template.

For the procedure for editing template attributes in the [Edit Template Attribute] dialog, refer to the following.
➟(4) Creating template attributes
(5) Deleting template attributes
(6) Registering attributes into template attributes
(7) Deleting attributes from the template attributes

(3) Deleting figures and objects from a template

Step 1 On the screen editor, select the figure or object to delete from the template.
Step 2 Either of the following operations deletes the figure or object from the template.

• Select [Edit] → [Template Registration] → [Deregister from Template] from the menu.
• Right-click the figure or object and select [Template Registration] → [Deregister from Template] from the 

menu.

(4) Creating template attributes

Step 1 Either of the following operations displays the [Edit Template Attribute] dialog.

These items are not displayed 
if there is no template on the screen editor.
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• Select the template information box or a figure/an object and select [Edit] → [Edit Template Attribute] from the 
menu.

• Right-click the template information box or the figure/object and select [Edit Template Attribute] from the menu.
➟11.6.4 [Edit Template Attribute] dialog

Step 2 Click the [New] button to display the [Template Attribute] dialog.

Step 3 Set [Type] and [Template Attribute Name] and click the [OK] button. The template attribute is created.

When the [Auto Sorting] button is clicked, the attributes in [Attribute List] are classified according to their types 
and are automatically registered in the automatically created corresponding template attributes.
Only the attributes in [Attribute List] are registered in the automatically created template attributes.
The target attributes for the automatic creation can be operated using [Refinement].
For the procedure for registering attributes in template attributes, refer to the following.
➟(6) Registering attributes into template attributes

(5) Deleting template attributes

Step 1 Either of the following operations displays the [Edit Template Attribute] dialog.
• Select the template information box or a figure/an object and select [Edit] → [Edit Template Attribute] from the 

menu.
• Right-click the template information box or the figure/object and select [Edit Template Attribute] from the menu.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟11.6.4 [Edit Template Attribute] dialog
Step 2 Either of the following operations deletes the template attribute.

• Drag the template attribute to delete from [Template Attribute List] to [Attribute List].
• Select the template attribute row to delete in [Template Attribute List] and click the [Delete] button.

The attributes that have been registered in the template attribute are also deleted.

(6) Registering attributes into template attributes

Step 1 Either of the following operations displays the [Edit Template Attribute] dialog.
• Select the template information box or a figure/an object and select [Edit] → [Edit Template Attribute] from the 

menu.
• Right-click the template information box or the figure/object and select [Edit Template Attribute] from the menu.
➟11.6.4 [Edit Template Attribute] dialog

Step 2 Drag the target attribute from [Attribute List] into a template attribute row in [Template Attribute List].

Step 3 The dragged attribute is registered in the template attribute.
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(7) Deleting attributes from the template attributes

Step 1 Either of the following operations displays the [Edit Template Attribute] dialog.
• Select the template information box or a figure/an object and select [Edit] → [Edit Template Attribute] from the 

menu.
• Right-click the template information box or the figure/object and select [Edit Template Attribute] from the menu.
➟11.6.4 [Edit Template Attribute] dialog

Step 2 Either of the following operations deletes the target attribute from the template attribute.
• Drag the attribute to delete from [Template Attribute List] to [Attribute List].
• Select the attribute row to delete in [Template Attribute List] and click the [Delete] button.

■3 Registering templates at the library

Step 1 Select [View] → [Docking Window] → [Library List] from the menu to display the [Library] window.

➟8.1.4 [Library] window
Step 2 In the [Library] window, display the folder into which the target template is registered.

The library folders into which templates can be registered are favorites and My Library.
To register into My Library, create a library folder in it.
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Step 3 Drag into the [Library] window the template information box of the target template for registering into the 
library. The [Library data Property] dialog appears.

Step 4 In the [Library data Property] dialog, set [No.] and [Name], then click the [OK] button. The template is 
registered in the library.

■4 Canceling template settings

Step 1 In the screen editor, select the template information box to delete.
Figures and objects selected together with the box are deleted simultaneously with the template.
When the template information box is double-clicked, all the registered figures and objects are selected.

Step 2 Either of the following operations cancels the target template setting.
• Select [Edit] → [Delete] from the menu.
• Right-click the template information box and select the [Delete] menu.
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11.6.3 Precautions

■1 Operations on figures and objects that have been registered in templates
(1) Registering into templates

Objects that have been registered in a template cannot be registered into another template.

(2) Replication operation
On figures and objects that have been registered in a template, a copy and paste, replication, and consecutive copy 
operation can be carried out.
However, replicas of figures and objects are not automatically registered into the template.

(3) Operations causing deletions from templates
When figures and objects that have been registered in a template are cut, deleted, or dragged onto another screen, they 
are deleted from the template.

(4) Grouping
Template information boxes and figures/objects that have been registered in templates are grouped only with the 
following combination.
• Figures and objects that have been registered in the same template

For the grouping method, refer to the following.
➟6.6.8 [Group], [Ungroup]

(5) Individual settings for figures and objects that have been registered in templates
The following describes the operations performed when the settings for figures and objects that have been registered in 
a template are changed individually in the setting dialog.
• When an attribute is added due to a change of the setting, the attribute is not automatically registered into the template 
attribute.

• When an attribute that has been registered in a template attribute is deleted due to a change of the setting, it is also 
deleted from the template attribute.

• After the setting is changed, if the change is canceled with [Undo], the registration status of the template attribute returns 
to the previous.

■2 Precautions of utilizing templates
The [Select CH No.] dialog is displayed only when the templates in the system library are utilized.
The dialog is not displayed when the templates that have been registered as favorites and in My Library. Also, Device 
conversion according to the controller setting is not carried out.

■3 Precautions of registering figures into a template
For cases where 10000 or more figures have been registered in a template, when the project is transferred to the GOT or 
data storage, the 10000th and those registered later are deleted from the template.
The project saved in the GOT or data storage is different from the one designed before the transfer. Exercise care when 
reading the project saved after the transfer.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.6.4 [Edit Template Attribute] dialog

1) [Template Attribute List]
Lists template attributes.
Attributes can be dragged between [Template Attribute List] and [Attribute List] to register into/delete from the template 
attributes.

For the operations with the mouse or keyboard, refer to the following.
➟■1 Mouse and keyboard operations

Up to 5000 figure/object attributes can be registered into a single template attribute.
The relation between a template attribute and the registered attributes are shown in a tree.

• Template attribute row: Displays template attributes.
• Figure/object attribute row: Displays the attributes of figures/objects that have been registered in the template attribute.

When a row is selected, handles appear for the figure/object on the screen editor that has the corresponding attribute.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1) 2) 3) 4) 5) 6) 7)

8)

Template attribute row

Figure/object attribute row
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2) [New] button
Displays the [Template Attribute] dialog.
A template attribute can be created.
Up to 255 template attributes can be possessed by a single template.

3) [Delete] button
Deletes a template attribute or attribute selected in [Template Attribute List].
When a template attribute is deleted, the attributes that have been registered in the template attribute are also deleted.

4) [↑], [↓] button
Moves a row selected in [Template Attribute List].
When a template attribute row is moved, the figure/object attributes that have been registered in the template attribute 
are also moved.
When multiple rows are selected, the difference between any two of successive rows is retained.
When a template attribute row is selected together with figure/object rows, they cannot be moved.

Item Description

[Type]
Displays the types of the template attributes. 
To change the settings, double-click them. 
When the settings are changed, the registered attributes are deleted.

[Template Attribute]

Each row displays different contents.
• Template attribute row:

Displays the names of the template attributes.
To change the settings, double-click them.
Up to 128 characters can be set.

• Figure/object attribute row:
Displays the types of the figures or names of the objects.
For the attributes of objects for which [Name] is not set, the types are displayed instead 
of the names.

[Setting Value] Displays the set values for the attributes. 
They cannot be changed.

[Points]

Each [Type] displays different contents.
• [Bit], [Word]: Displays the number of the consecutive devices.
• [Number] having the consecutive or random setting: Displays the number of the 

consecutive values.

[Individual Attribute]

Each row displays different contents.
• Template attribute row:

Displays the names of the attributes that have been registered in the template attribute.
Additionally, conditions are displayed if set.
For a script part, the attribute name and execution order number of each script are 
displayed.

• Figure/object attribute row:
Displays the names of the figure/object attributes.
Additionally, conditions are displayed if set.
For a script part, the attribute name and execution order number of each script are 
displayed.

• [Type]
Select the type of the template attribute to create.
The following shows selectable items.
• [Bit]
• [Word]
• [Color]
• [Number]
• [Text]
• [Shape]
• [Font]
• [Text Size]

• [Template Attribute Name]
Set the name of the template attribute.
Up to 128 characters can be set.

If not grouped If grouped

The handles indicate that the figure/object has the corresponding attribute.
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5) [Auto Sorting] button
Classifies all the attributes displayed in [Attribute List] according to set value and registers them into the template 
attributes automatically created in [Template Attribute List].
The classification method depends on [Type].

6) [Attribute List]
Lists the figures and objects that have been registered and those in the process of being registered.
Attributes can be dragged between [Template Attribute List] and [Attribute List] to register into/delete from the template 
attributes.

For the operations with the mouse or keyboard, refer to the following.
➟■1 Mouse and keyboard operations

The text color of the attributes that have already been registered becomes gray.
The relation between figures/objects and attributes are shown in a tree.

• Figure/object row: Displays the figures and objects.
• Attribute row: Displays the attributes the figures and objects have.

Clicking the top row sorts the results by item.
When a row is selected, the corresponding figure/object on the screen editor is displayed.

Item Description

[Type] Displays the types of the attributes.

[Individual Attribute]

Each row displays different contents.
• Figure/object row:

Displays the types of the figures or names of the objects and the object ID.
For the attributes of objects for which [Name] is not set, the types are displayed instead 
of the names.

• Attribute row:
Displays the names of the figure/object attributes.
Additionally, conditions are displayed if set.
For a script part, the attribute name and execution order number of each script are 
displayed.

[Setting Value] Displays the set values for the attributes. 
They cannot be changed.

Figure/object row

Attribute row

If not grouped If grouped

The handles indicate the corresponding figure/object.
11. USEFUL FUNCTIONS
11.6 Efficient Drawing with Templates

11 - 93



7) [Refinement]
Narrows the displayed contents of [Attribute List] by keywords.
Up to 128 characters can be set.
This search operation is case-insensitive.
To narrow the contents using multiple keywords, separate each keyword with one-byte spaces.

8) [Show only the figures/objects selected on the editing screen]
Displays in [Attribute List] only the figures and objects selected on the screen editor when the [Edit Template Attribute] 
dialog is opened.
When the [Edit Template Attribute] dialog is opened for a newly created template, no entry is displayed.

■1 Mouse and keyboard operations

(1) Operations for the lists on display
The following table describes the mouse and keyboard operations for [Template Attribute List] and [Attribute List] in the 
[Edit Template Attribute] dialog.

[Points]

Each [Type] displays different contents.
• [Bit], [Word]: Displays the number of the consecutive devices.
• [Number] having the consecutive or random setting: Displays the number of the 

consecutive values.

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Operation [Template Attribute List] [Attribute List]

Arrow (Up/Down)

Moves the cursor.

Moves the focus upward or downward.

Arrow (Left)

• When a figure/object row is selected
Folds an unfolded tree.
If the tree has been folded, moves the focus upward.

• When an attribute row is selected
Moves the focus up to a figure/object row.

Arrow (Right)

• When a figure/object row is selected
Unfolds a folded tree.
If the tree has been unfolded, moves the focus 
downward.

• When an attribute row is selected
Moves the focus downward.

[Shift] + Arrow (Up/Down)
Moves the row while selecting the row where the cursor 
is positioned 
The destination row of the cursor is also selected.

Moves the row while selecting the row where the cursor 
is positioned 
The destination row of the cursor is also selected.

[+] (Numeric keypad) Unfolds the tree of the template attribute row where the cursor was placed.

[-] (Numeric keypad) Folds the tree of the template attribute row where the cursor was placed.

[Shift] + [+] (Numeric keypad) Unfolds all the trees.

[Shift] + [-] (Numeric keypad) Folds all the trees.

[Home] Moves the cursor to the top row. Selects the top row.

[End] Moves the cursor to the bottom row. Selects the bottom row.

[PageUp] Moves the cursor up one page. Moves the cursor up one page.

[PageDown] Moves the cursor down one page. Moves the cursor down one page.

[Shift] + [Home] Selects the rows from the row where the cursor is 
positioned to the top row.

Selects the rows from the row where the cursor is 
positioned to the top row.

[Shift] + [End] Selects the rows from the row where the cursor is 
positioned to the bottom row.

Selects the rows from the row where the cursor is 
positioned to the bottom row.

[Shift] + [PageUp]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves up one 
page.

Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves up one 
page.

[Shift] + [PageDown]
Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves down one 
page.

Selects the rows from the row where the cursor is 
positioned to the row where the cursor moves down one 
page.

[Shift] + Click Selects the rows from the row where the cursor is 
positioned to the row where the mouse is clicked.

Selects the rows from the row where the cursor is 
positioned to the row where the mouse is clicked.

[Ctrl] + [Space]
Selects or deselects a row.

[Ctrl] + click
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(2) Operations when a cell is edited
The following table lists the keyboard operations for editing cells in [Template Attribute List].

11.6.5 [Register to Template] dialog

1) [New]
Newly creates a template into which figures and objects are registered.

2) [Add]
Specifies an existing template as the target for registration.
Select the target template.

[F2] Enables the cell where the cursor was placed to be 
edited. 
The target columns for editing are [Type] and [Template 
Attribute] in a template attribute row.

➟(2) Operations when a cell is 
edited

-
Double-click

Drag

• Dragging from [Attribute List] to [Template Attribute List]
Registers a dragged attribute into a template attribute.

• Dragging from [Template Attribute List] to [Attribute List]
Deletes a dragged attribute from a template attribute.

Operation [Template Attribute List] [Attribute List]

Operation [Template Attribute List]

[Enter] Confirms and ends the edit.

[Esc] Discards and ends the edit.

Item Description

[New Template Name] Set the name of the template to create. 
Up to 128 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
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11.6.6 [Property] window (when the template property is displayed)

The following describes the screen layout shown when the template setting is displayed in the [Property] window.

1) [Template Name]
Displays the template name.
The name can be changed.
Up to 128 characters can be set.

2) [Unfold All] button
Expands all template attribute items.

3) [Fold All] button
Collapses all template attribute items.

4) Template attribute list
Lists template attributes.
The set values for attributes can be batch changed by template attribute.
Example) Changing the first device of the device range (X0000 to X0003) of a template attribute to X1000

For the operations with the mouse or keyboard, refer to the following.
➟■1 Mouse and keyboard operations

The relation between a template attribute and the registered attributes are shown in a tree.

• Template attribute row: Displays the template attribute rows.
• Figure/object attribute row: Displays the attributes of figures/objects that have been registered in the template attribute.

Clicking the top row sorts the results by item.
When a row is selected, handles appear for the figure/object on the screen editor that has the corresponding attribute.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

4)

2) 3)

The difference between any two of 
successive device numbers is retained.

Monitor Device (Type: Bit)

X0000 (Device of bit lamp 1)
X0001 (Device of bit lamp 2)
X0002 (Device of bit lamp 3)
X0003 (Device of bit lamp 4)

Monitor Device (Type: Bit)

X1000 (Device of bit lamp 1)
X1001 (Device of bit lamp 2)
X1002 (Device of bit lamp 3)
X1003 (Device of bit lamp 4)

Template attribute row

Figure/object attribute row
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When a figure/object attribute row is double-clicked, the setting dialog of the corresponding figure/object is displayed.

■1 Mouse and keyboard operations
(1) Operations for the lists on display

The following table shows how to operate the template attribute list in the [Property] window with the mouse or keyboard.

Item Description

[Template Attribute]

Each row displays different contents.
• Template attribute row:

Displays the names of the template attributes.
To change the settings, double-click them.
Up to 128 characters can be set.

• Figure/object attribute row:
Displays the types of the figures or names of the objects.
For the attributes of objects for which [Name] is not set, the types are displayed instead 
of the names.

[Setting Value]

Each row displays different contents.
• Template attribute row:

Displays the background color of set values in white when the conditions for batch 
change are satisfied.
Displays the background color of set values in gray when the conditions for batch change 
are not satisfied.
For the conditions for batch change and the procedure for the change, refer to the 
following.

➟11.6.2 ■1 (4) Batch changing the set values for attributes
• Figure/object attribute row:

Displays the set values for figures and objects.

[Points]

Each [Type] displays different contents.
• [Bit], [Word]: Displays the number of the consecutive devices.
• [Number] having the consecutive or random setting: Displays the number of the 

consecutive values.

[Individual Attribute]

Each row displays different contents.
• Template attribute row:

Displays the names of the attributes that have been registered in the template attribute.
Additionally, conditions are displayed if set.
For a script part, the attribute name and execution order number of each script are 
displayed.

• Figure/object attribute row:
Displays the names of the figure/object attributes.
Additionally, conditions are displayed if set.
For a script part, the attribute name and execution order number of each script are 
displayed.

[Type] Displays the types of the template attributes.

If not grouped If grouped

The handles indicate that the figure/object has the corresponding attribute.

Operation Action

Arrow (Up/Down/Left/Right) Moves the cursor.

[Shift] + Arrow (Up/Down) Moves the row while selecting the row where the cursor is positioned 
The destination row of the cursor is also selected.

[+] (Numeric keypad) Unfolds the tree of the template attribute row where the cursor was placed.

[-] (Numeric keypad) Folds the tree of the template attribute row where the cursor was placed.

[Shift] + [+] (Numeric keypad) Unfolds all the trees.

[Shift] + [-] (Numeric keypad) Folds all the trees.

[Home] Moves the cursor to the top row.

[End] Moves the cursor to the bottom row.

[PageUp] Moves the cursor up one page.

[PageDown] Moves the cursor down one page.
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(2) Operations when a cell is edited
The following table lists the keyboard operations for editing cells in [Template Attribute List].

[Shift] + [Home] Selects the rows from the row where the cursor is positioned to the top row.

[Shift] + [End] Selects the rows from the row where the cursor is positioned to the bottom row.

[Shift] + [PageUp] Selects the rows from the row where the cursor is positioned to the row where the cursor moves up one page.

[Shift] + [PageDown] Selects the rows from the row where the cursor is positioned to the row where the cursor moves down one page.

[Shift] + Click Selects the rows from the row where the cursor is positioned to the row where the mouse is clicked.

[Ctrl] + [Space]
Selects or deselects a row.

[Ctrl] + Click

[Tab] Moves the cursor to the right cell.

[Shift] + [Tab] Moves the cursor to the left cell.

[Enter] Moves the cursor downward by one row.

[Alt] + [Enter] Displays the setting dialog for the figure/object corresponding to the figure/object attribute row where the cursor was 
placed.

[Ctrl] + [C]

• Template attribute row
Copies the set value in the cell of [Template Attribute] where the cursor was placed as a character string.

• Figure/object attribute row
Copies the cell of [Setting Value] where the cursor was placed.

[Ctrl] + [V]

• Template attribute row
Pastes a character string in the cell of [Template Attribute] being edited.

• Figure/object attribute row
Pastes in the cell of [Setting Value] where the cursor was placed.

[F2]
Enables the cell where the cursor was placed to be edited. 
The target columns for editing are [Template Attribute] (template attribute rows only) and [Setting Value].

➟(2) Operations when a cell is edited

Double-click

• Columns of [Template Attribute] (template attribute rows only) and [Setting Value]
Enables the cell to be edited.

• Any cell other than above
Displays the setting dialog for the shape/object having attributes.

➟(2) Operations when a cell is edited

Drag

• Dragging from [Attribute List] to [Template Attribute List]
Registers a dragged attribute into a template attribute.

• Dragging from [Template Attribute List] to [Attribute List]
Deletes a dragged attribute from a template attribute.

Operation Action

Operation Action

[Enter] Confirms and ends the edit.

[Esc] Discards and ends the edit.

[Tab] Confirms the edit and moves the cursor to the right cell.

[Shift] + [Tab] Confirms the edit and moves the cursor to the left cell.

[Alt] + [Enter] Inserts a line feed when text is input.
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11.7 Managing figures and objects by category

Figures and objects can be managed by grouping them into categories according to the usage.

The devices and shapes set for figures or objects can be changed by category in a batch.
➟11.7.1 Specifications of the category
11.7.2 How to use the category
11.7.3 Precautions
11.7.4 [Category List] window

11.7.1 Specifications of the category

➟■1 Category type
■2 Registering into categories
■3 Operations which can be performed by category

■1 Category type

[Switch], [Lamp], and [Other] are provided as default categories.
Categories can be created by a user.

■2 Registering into categories

Each figure and object can be registered to one category.
One figure/object cannot be registered to multiple categories.
When figures and objects are placed on the screen editor, they are registered to the default categories as described below.
• Switch: Registered to [Switch].
• Lamp: Registered to [Lamp].
• Other than the above: Registered to [Other].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Category

Objects for line A

Bit lamp (base screen 1)

Bit lamp (base screen 2)

Bit switch (base screen 1)

Bit switch (base screen 2)

Numerical display (base screen 1)

Text display (base screen 2)

Objects for line B

Bit lamp (base screen 1)

Bit lamp (base screen 2)

Bit switch (base screen 1)

Bit switch (base screen 2)

Numerical display (base screen 1)

Text display (base screen 2)

Base screen 1

1234

1234

Base screen 2

ABC

ABC

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Operations which can be performed by category

The following shows the operations which can be performed on registered figures and objects on a category basis.
• Device batch edit:

Change devices in a batch.
• Unit No./axis No. batch edit:

Change unit numbers and axis numbers in a batch.
• Network batch edit:

Change the network settings in a batch, such as the network number, station number, and CPU number.
• CH No. batch edit:

Change channel numbers in a batch.
• Color batch edit:

Change colors in a batch.
• Shape batch edit:

Change the shapes of touch switches and lamps in a batch.

11.7.2 How to use the category

➟■1 Creating categories
■2 Changing the destination category for registering figures and objects
■3 Batch changing the settings by category

■1 Creating categories

Step 1 Select [View] → [Docking Window] → [Category List] from the menu to display the [Category List] window.

➟11.7.4 [Category List] window
Step 2 Right-click any one of the categories and select [New Category] from the menu to display the [Edit Category] 

dialog.

Step 3 Set the name of a new category and click the [OK] button.
Up to 32 characters can be set.

Step 4 A category is created.

Creating a new category and registering a figure or an object to the category can be performed simultaneously.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟11.7.2 ■2 (2) Changing from the menu
11.7.2 ■2 (3) Changing in the setting dialog of figure or object

■2 Changing the destination category for registering figures and objects

➟(1) Changing in the [Category List] window
(2) Changing from the menu
(3) Changing in the setting dialog of figure or object

(1) Changing in the [Category List] window

Step 1 Select [View] → [Docking Window] → [Category List] from the menu to display the [Category List] window.

➟11.7.4 [Category List] window
Figures and objects in a closed screen are not displayed in the [Category List] window.
Open the screen on which the target figure or object for putting into another category has been placed.
➟2.5.2 ■1 Opening screens

Step 2 Drag the target figure or object into the destination category. The category is changed.

(2) Changing from the menu

Step 1 Select the target figure or object for placing into another category on the screen editor, then select [Edit] → 
[Add to Category] from the menu, and then select any one of the following categories.
• [Switch]

Changes the destination category for registration to [Switch].
• [Lamp]

Changes the destination category for registration to [Lamp].
• [Other]

Changes the destination category for registration to [Other].
• [User-defined Category]

Displays the [Add to Category] dialog.
Change or create a category.
Proceed to step 2.

Step 2 Set the destination category for registration for [Category] and click the [OK] button to change the category 
of the figure or object.
If [None] is selected, the figure or object is not registered to any categories.
If a nonexistent category is set, the category is newly created and the target is registered.
Up to 32 characters can be set.
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(3) Changing in the setting dialog of figure or object

Step 1 On the screen editor, double-click the target figure or object for placing into another category to display the 
setting dialog.

Step 2 Set the destination category for registration for [Category] and click the [OK] button to change the category 
of the figure or object.
If [None] is selected, the figure or object is not registered to any categories.
If a nonexistent category is set, the category is newly created and the target is registered.
Up to 32 characters can be set.
Example) The setting dialog of a bit lamp

■3 Batch changing the settings by category

Step 1 Select [View] → [Docking Window] → [Category List] from the menu to display the [Category List] window.

➟11.7.4 [Category List] window
Step 2 Right-click any one of the categories and select the following menus according to the target settings for 

batch change.
• [Device Batch Edit]: Change devices in a batch.
• [Unit No./Axis No. Batch Edit]: Change unit numbers and axis numbers in a batch.
• [Network Batch Edit]: Change the network settings in a batch, such as the network number, station 

number, and CPU number.
• [CH No. Batch Edit]: Change channel numbers in a batch.
• [Color Batch Edit]: Change colors in a batch.
• [Shape Batch Edit]: Change the shapes of touch switches and lamps in a batch.

Step 3 The setting dialog which is corresponding to the selected menu is displayed.
For the description of each setting dialog, refer to the following.
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➟11.8.4 ■3 [Device Batch Edit] dialog
　 11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog
　 11.8.4 ■5 [Network Batch Edit] dialog
　 11.8.4 ■6 [CH No. Batch Edit] dialog
　 11.8.4 ■7 [Color Batch Edit] dialog
　 11.8.4 ■8 [Shape Batch Edit] dialog

Step 4 Select the search target in [Category] and click the [Find Now] button to display the settings for which batch 
change is enabled.
Example) [Device Batch Edit] dialog

Step 5 Change the settings in [After] and click the [Replace] button to apply the settings collectively.

11.7.3 Precautions

■1 Project for which project security is set
If a login user does not have access to edit projects, the user cannot create or change any categories.

■2 Precautions for batch change
(1) Figures and objects not displayed in the [Category List] window

Figures and objects in a closed screen are not displayed in the [Category List] window.
However, figures and objects that have been registered in categories are identified as the targets for batch change even 
if the figures and objects are not displayed in the [Category List] window.

(2) Other precautions
➟11.8.4 ■2 Precautions

Settings for which batch change is enabled

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.7.4 [Category List] window

1) Category list
Lists the categories in the project.
[Switch], [Lamp], and [Other] are default categories.
Registered figures and objects in each category are displayed in a tree view.

A category of figures and objects can be changed by dragging them to another category.
Right-click a category, a figure, or an object to display a menu for operating a category.

2) Right-click menu of category

Item Description

[New Category]

Displays the [Edit Category] dialog. 
Create a new category.

• Category I
Set a category's name.
Up to 32 characters can be set.

[Rename Category]

Displays the [Edit Category] dialog. 
Change the name of the right-clicked category. 
The names of [Switch], [Lamp], [Other] cannot be changed.

• Category I
Set a category's name.
Up to 32 characters can be set.

[Delete Category]
Deletes the right-clicked category. 
The registered figures, objects are deleted from the category. 
[Switch], [Lamp], [Other] cannot be deleted.

[Device Batch Edit]
Displays the [Device Batch Edit] dialog. 
Change devices in a batch.
➟11.8.4 ■3 [Device Batch Edit] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2) 3)

Types of figures/objects

Placed screens
· B: Base screen
· W: Window screen

Coordinates that indicate the positions

· M: Mobile screen
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3) Right-click menu of a figure or an object

[Unit No./Axis No. Batch Edit]
Displays the [Unit No./Axis No. Batch Edit] dialog.
Change unit numbers and axis numbers in a batch.

➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

[Network Batch Edit]

Displays the [Network Batch Edit] dialog. 
Change the network settings in a batch, such as the network number, station number, and 
CPU number.
➟11.8.4 ■5 [Network Batch Edit] dialog

[CH No. Batch Edit]
Displays the [CH No. Batch Edit] dialog. 
Change channel numbers in a batch.
➟11.8.4 ■6 [CH No. Batch Edit] dialog

[Color Batch Edit]
Displays the [Color Batch Edit] dialog. 
Change colors in a batch.
➟11.8.4 ■7 [Color Batch Edit] dialog

[Shape Batch Edit]
Displays the [Shape Batch Edit] dialog. 
Change the shapes of touch switches and lamps in a batch.
➟11.8.4 ■8 [Shape Batch Edit] dialog

Item Description

[Move]

Displays the [Move to Category] window. 
Change the destination category for registration of the right-clicked figure or object.

• Category I
Change the destination category for registration.
If [None] is selected, the figure or object is not registered to any categories.
If a nonexistent category is set, the category is newly created and the target is 
registered.
Up to 32 characters can be set.

[Remove] Deletes the right-clicked figure or object from the category.

[Open Editing Screen] Selects the right-clicked figure or object on the screen editor.

Item Description
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11.8 Searching for and Editing Settings of Projects

➟11.8.1 Searching for a device (Device search)
11.8.2 Listing devices (Device list)
11.8.3 Listing strings (Text list)
11.8.4 Changing the set values in a batch (Batch Edit)
11.8.5 Searching for and editing a specific setting (Data Browser)
11.8.6 Checking the IP addresses in the list (IP address list)

11.8.1 Searching for a device (Device search)

Search the current project for devices, labels, or tags.
You can perform a keyword search, identify which functions use the found devices, and change the related settings.

➟■1 How to use the device search
■2 Precautions for the device search
■3 [Device Search] window

■1 How to use the device search
➟(1) Searching the project for matching devices

(2) Changing or deleting the settings related to a found device
(3) Exporting the search result list data

(1) Searching the project for matching devices
Step 1 Perform one of the following operations to display the [Device Search] window.

• Press the [Ctrl] + [F] key combination.
• Select [Search/Replace] → [Device Search] from the menu.
• Select [View] → [Docking Window] → [Device Search] from the menu.
• Click the [Device Search] button on the toolbar.
• Select [Device Search] from the right-click context menu.

➟■3 [Device Search] window
Step 2 Set the search criteria and click the [Search] button to display the found devices, labels, or tags in the search 

result list.
When [Search Mode] is set to [Keyword (Label/Tag)], [Keyword (Label)], or [Keyword (Device)], if [Keyword] 
is left blank, clicking the [Search] button lists all the devices, labels, or tags used in the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search criteria

Search result list
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(2) Changing or deleting the settings related to a found device
Step 1 Search for devices in the [Device Search] window.

➟(1) Searching the project for matching devices
Step 2 Double-click a found device in the search result list to display the setting dialog for the figure, object, or 

common setting where the device is specified.
Change or delete settings as necessary.

Step 3 Click the [Search] button again to apply setting changes to the search result list.

(3) Exporting the search result list data
Step 1 Search for devices in the [Device Search] window.

➟(1) Searching the project for matching devices
Step 2 Click the [Export] button to display the [Save As] dialog.
Step 3 Set [File name] and [Save as type] and click the [Save] button to export the search result list.

■2 Precautions for the device search
(1) Unsupported devices

The following devices are not listed in the [Device Search] window.
• Devices used for the display-prohibited screens or scripts in a project protected with the project security
• Devices used for the MES interface function
• Devices assigned to script symbols

(2) Searching for the devices of non-Mitsubishi Electric equipment
Among the devices of non-Mitsubishi Electric equipment, some bit devices and word devices are used for the same 
purpose, but have different device names.
When [Search Mode] is set to [Device], the search result list will display the specified device and other devices that are 
used for the same purpose as the specified device.
To find the specified device only, select [Keyword (Device)] for [Search Mode].

The object using the device is selected.

The object setting dialog is displayed.
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■3 [Device Search] window

1) [Search Mode]
Select a search mode.
The following shows selectable items.

• [Device]
Searches for the device that matches the specified device, channel number, and network setting.
If one of consecutive devices is specified, the start device of the consecutive devices is searched for.

• [Keyword (Label/Tag)] (for GT27, GT25, GT23, GT21 except GT2105-Q, GT SoftGOT2000, GS25, and GS21)
Searches for labels and tags containing the specified keyword.

• [Keyword (Label)] (for GT2105-Q only)
Searches for labels containing the specified keyword.

• [Keyword (Device)]
Searches for devices containing the specified keyword.

2) [Specify the range]
This item appears when [Search Mode] is set to [Device].
Enables the setting to specify the scope of a search.

3) [Device]
This item appears when [Search Mode] is set to [Device].
Specify a device, channel number, and network setting.
If you specify no channel number and network setting, channel No. 1 and 0-FF (host station) are assumed.
The search result list will display the device matching the specified conditions or the start device of consecutive 
devices containing the matching device.
The device, channel number, and network setting are settable in the [Setting] dialog alternatively.

4) [...] button
This item appears when [Search Mode] is set to [Device].
Displays the [Setting] dialog.
Specify a device, channel number, and network setting.

When [Search Mode] is set to [Device] When [Search Mode] is set to any other than [Device]

1)1) 2)
3)

4)
5)

6)7) 7)

9)9)

8) 8)
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If you specify no channel number and network setting, channel No. 1 and 0-FF (host station) are assumed.

5) [Range]
This item appears when [Specify the range] is selected.
Specify the number of devices and the device type.

The consecutive devices starting from the specified device are searched for.
The maximum number of devices varies depending on the device name.
The following shows selectable device types.

• [Bit]
• [Byte]
• [Word]
• [Double Word]
• [Quad Word]

6) [Keyword]
This item appears when [Search Mode] is set to [Keyword (Label/Tag)], [Keyword (Label)], or [Keyword (Device)].
Specify a search keyword.
The labels, tags, or devices containing the specified keyword will be listed in the search result list.
To specify multiple keywords, enter a one-byte space between them.

7) [Search] button
Performs a search.
The hits will be listed in the search result list.
If two or more objects and figures are selected on the screen editor, the devices, labels, or tags specified for the 
objects and figures will be searched.
In this case, the title bar of the window displays [selected range].

8) Search result list
Lists the search results.
Right-click the column header of the list to select columns to be displayed.

• [Device Type]
Select the data type of a device.
The following shows selectable items.
• [Bit]
• [Byte]
• [Word]
• [Double Word]
• [Quad Word]

• [Device]
Specify a device, channel number, and network setting.
➟6.1.2 How to set devices

Column Description

[Label/Tag], [Label] Labels or tags that contain the string specified with [Keyword]

[Device]

• When [Search Mode] is set to [Device]
Device matching the specified device, channel number and network setting, or the start 
device of consecutive devices containing the matching device

• When [Search Mode] is set to [Keyword (Label/Tag)] or [Keyword (Label)]
Devices assigned to the found labels or tags

• When [Search Mode] is set to [Keyword (Device)]
Devices that contain the string specified with [Keyword]

[CH No.] Channel numbers specified for the devices listed

Number of devices Device type
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9) [Export] button
Exports the contents of the [Device Search] window to a CSV file or Unicode text file.
The exported file does not include information on the search criteria used, so take a note of the information as 
necessary.

(1) Mouse and keyboard operations
The following shows the mouse and keyboard operations for the search result list in the [Device Search] window.

[Network]

Network numbers, station numbers, and CPU numbers that are specified for the devices 
listed
Example) When network No. 1, station No. 2, and CPU No. 3 are set

[Screen]

Locations where the devices listed are set
"n" represents a screen number.
• [Common]: Common setting
• [B-n]: Base screen
• [W-n]: Window screen
• [R-n]: Report screen
• [M-n]: Mobile screen

[Function] Functions that use the devices listed

[ID/No.] Object IDs of the objects where the devices listed are set, or setting numbers of the 
functions where the devices listed are set

[Data Type] Data types of the devices listed

[Points] Number of consecutive devices

Column Description

CPU No.
Station No.

Network No.

Operation Description

Arrow (up or down) Move the cursor.

[Enter] Move the cursor down one row.

[Home]
[Ctrl] + Arrow (up)

Move the cursor to the top row.

[End]
[Ctrl] + Arrow (down)

Move the cursor to the bottom row.

[PageUp] Move the cursor up one page.

[PageDown] Move the cursor down one page.

Click Select the figure or object where the selected device is set, on the screen editor.

Double click Open the setting dialog for the figure, object, or common setting where the selected device 
is set.
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11.8.2 Listing devices (Device list)

The devices and labels used in the project are displayed in a list.
You can narrow the targets displayed in the list, jump to the location where a selected device is used, and export the 
device list.

➟■1 How to use the device list
■2 Precautions
■3 [Device List] window
■4 Details of the exported file

■1 How to use the device list

➟(1) Listing the devices used in the project
(2) Searching for a device or jumping to the location where a selected device is used
(3) Exporting the device list

(1) Listing the devices used in the project

Step 1 Select [Search/Replace] → [Device List] from the menu then select either of the following items to display 
the [Device List] window.

➟11.8.2 ■3 [Device List] window
• [Screen]:

Displays the [Device List] window and sets the currently selected screen editor as the target for collecting 
devices.

• [Project]:
Displays the [Device List] window and sets the whole project (including script texts) as the target for collecting 
devices.

• [Script Text]:
Displays the [Device List] window and sets all script texts as the target for collecting devices.

Step 2 After selecting any item for [Collection Target], click the [Update] button to update the device list.
To switch the display of bit devices, word devices, labels, and others, switch the tabs.

Even though any device setting is changed while the [Device List] window is displayed, the device list is not 
automatically updated.
If the device list being displayed is not in the latest condition, [*] is displayed in the title bar.
Click the [Update] button to update the list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Tab

Device list

[*] indicates that the device list being displayed is not in the latest condition.
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Cross reference function for MELSOFT Navigator (iQ Works only)
To search a system label used for another project in a workspace, use the cross reference function for 
MELSOFT Navigator.

➟Help on MELSOFT Navigator

(2) Searching for a device or jumping to the location where a selected device is used

Step 1 Display the [Device List] window.

➟(1) Listing the devices used in the project
Step 2 Select a target in which the device you search for is included for [Collection Target] and click the [Update] 

button.
Step 3 Switch the following tabs according to the target you search for.

• [Bit] tab: Displays bit devices.
• [Word] tab: Displays word devices.
• [Label/Tag] tab ([Label] tab for GT2105-Q): Displays labels or tags.

Step 4 Set a device or label you search for and click the [Search] button.
• [Bit] tab: Set [Device].
• [Word] tab: Set [Device] and [Data Size].
• [Label/Tag] tab ([Label] tab for GT2105-Q): Set [Label/Tag Name] or [Label Name].

Step 5 The corresponding device is selected in the device list.

Step 6 If you select a device in the device list and click the [Jump] button, a figure or an object for which the selected 
device is used is selected on the screen editor.
If any device which has been used for something other than figures and objects is selected, the [Jump] button 
is disabled.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The found device

Device to be searched for Starts searching.

Jump to the location where the device is used
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(3) Exporting the device list

Step 1 Display the [Device List] window.

➟(1) Listing the devices used in the project
Step 2 Click the [Export] button to display the [Save As] dialog.
Step 3 Set [File name] and [Save as type] and click the [Save] button to export the device list.

➟■4 Details of the exported file

■2 Precautions

(1) Project for which project security is set
The devices used for display-disabled screens or scripts are not displayed in the [Device List] window.

■3 [Device List] window

1) [Collection Target]
Select a target to be displayed in the device list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

When the [Bit] tab is selected

When the [Word] tab is selected

When the [Label/Tag] tab is selected

1)

5)

9)

6)

7)

8)5)

9)

5)

2) 3)

4)

9)
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After changing any device setting, click the [Update] button to update the device list.
The following shows selectable items.

• [Project (incl. Script Text)]
• [Project (excl. Script Text)]
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)
• [All Script Text]
• [Script List]
• [Project/Screen Script Text]
• [Object Script Text] (Not available to GT21 and GS21)
• [Script Parts Script Text]

2) Target screen number
When [Base Screen], [Window Screen], [Report Screen], or [Mobile Screen] is selected for [Collection Target], set the 
screen number to be searched for.
The following shows the setting range.

• [Base Screen], [Window Screen], or [Mobile Screen]: [0] to [32767]
• [Report Screen]: [1] to [99]

3) [All screens]
When [Base Screen], [Window Screen], [Report Screen], or [Mobile Screen] is selected for [Collection Target], all the 
screens of the selected screen type are targeted for collection.
If you check this item, the target screen number is disabled.

4) [Type] ([Label Type] for GT2105-Q)
Select the type of the labels or tags displayed in the device list.
The following shows selectable items.

• [All]
• [System Label]
• [Label (GT Designer3)]
• [Global Label] (Not available to GT21 and GS21)
• [OMRON NJ/NX Tag]
• [AB Native Tag]
• [OPC UA Tag]

5) [Search]
Set search conditions.

Item Description

[Device] Set a device you search for.

[Data Size]

This item is displayed when the [Word] tab is selected. 
Set a data size of the device you search for. 
The following shows selectable items.
• [16bit]
• [32bit]
• [64bit]
• [8bit]

[Label/Tag Name] ([Label Name] for GT2105-
Q)

This item is displayed when the [Label/Tag] tab or the [Label] tab is selected. 
Set the label name or tag name you search for.
11 - 114 11. USEFUL FUNCTIONS
11.8 Searching for and Editing Settings of Projects



U
SE

FU
L 

FU
N

C
TI

O
N

S

11
6) [Update] button
Updates the device list.
If the device list being displayed is not in the latest condition, [*] is displayed in the title bar of the [Device List] window.

7) [Jump] button
Displays a figure or object for which the device selected in the device list is used.
If any device which is used for something other than figures and objects is selected, the [Jump] button is disabled.

8) [Export] button
Saves the device list as a CSV file or Unicode text file.
Set [File name] and [Save as type] in the displayed dialog and click the [Save] button.

➟■4 Details of the exported file
9) Device list

The list of the devices used in the project.
Each tab displays different contents.
Switch the following tabs according to the contents to be checked.

• [Bit] tab: Displays the list of bit devices.
• [Word] tab: Displays the list of word devices.
• [Label/Tag] tab ([Label] tab for GT2105-Q): Displays the list of labels or tags.

Dragging each column enables changing the width of column.

[...] button

Displays the device setting dialog when the [Bit] tab or the [Word] tab is selected.
When the [Label/Tag] tab or the [Label] tab is selected, the dialog to appear varies with the 
selection for [Type] as shown below.
• When [System Label] is selected for [Type], the [Import System Labels to Project] 

appears.

➟6.1.3 ■3 System label setting
• When [Label (GT Designer3)] is selected for [Type], the [Select Label (GT Designer3)] 

dialog appears.

➟6.1.5 ■9 [Select Label (GT Designer3)] dialog
• When [Global Label] is selected for [Type], the [Select Global Label] dialog appears.

➟6.1.4 ■8 [Select Global Label] dialog
• When [OMRON NJ/NX Tag] is selected for [Type], the [Select OMRON NJ/NX Tag] dialog 

appears.

➟6.1.7 ■8 [Select OMRON NJ/NX Tag] dialog
• When [OPC UA Tag] is selected for [Type], the [Select OPC UA Tag] dialog appears.

➟6.1.10 ■6 [Select OPC UA Tag] dialog

[Search] button Starts searching.

Item Description

[Label/Tag Name] ([Label Name] for GT2105-
Q)

This item is displayed on the [Label/Tag] tab or the [Label] tab. 
Label names or tag names

[CH], network No., station number, CPU No.

Channel Nos., network Nos., station numbers, and CPU Nos. 
Example) For the device with the channel No. 2, network No. 1, station number 2, and CPU 
No. 3

If the same device is consecutively displayed, the text color of the second row and later 
rows is gray.

[Device]
Devices 
If the same device is consecutively displayed, the text color of the second row and later 
rows is gray.

[Data Type] Data type of the devices

[Points] Number of devices which are consecutively set

Item Description

Channel No.

CPU No.
Station

Network No.
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■4 Details of the exported file

The following shows the details of the exported file of the device list.

1) Collection target
The setting of the collection target

2) [Bit]
The details of the [Bit] tab

3) [Word]
The details of the [Word] tab

4) [Label/Tag] ([Label] for GT2105-Q)
The details of the [Label/Tag] tab or the [Label] tab

5) [Label/Tag Name] ([Label Name] for GT2105-Q)
Label names or tag names

6) [CH], network No., station number, CPU No.
Channel Nos., network Nos., station numbers, and CPU Nos.
If the same device is consecutively displayed, the second row and later row in this column are blank.

7) [Device]
Devices
If the same device is consecutively displayed, the text color of the second row and later rows is gray.

8) [Data Type]
Data type of the devices

9) [Points]
Number of devices which are consecutively set

10) [Screen]
Screens for which the devices are used

[Screen]

Screens for which the devices are used
• [Common]: Common setting
• [B-n]: Base screen ("n" indicates the screen number.)
• [W-n]: Window screen ("n" indicates the screen number.)
• [R-n]: Report screen ("n" indicates the screen number.)
• [M-n]: Mobile screen ("n" indicates the screen number.)

[Function] Function names for which the devices are used

[Name] Names of figures and objects

[Position] Coordinates where the figures and objects are placed

[Object ID] Object IDs of the figures and objects

Item Description

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

6) 7) 8) 9) 10) 11) 12) 13) 14)

6)

4)

5)

7) 8) 9) 10) 11) 12) 13) 14)6)
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• [Common]:
Common setting

• [B-n]:
Base screen
"n" indicates the screen number.

• [W-n]:
Window screen
"n" indicates the screen number.

• [R-n]
Report screen
"n" indicates the screen number.

• [M-n]
Mobile screen
"n" indicates the screen number.

11) [Function]
Function names for which the devices are used

12) [Name]
Names of figures and objects

13) [Position]
Coordinates where the figures and objects are placed

14) [Object ID]
Object IDs of the figures and objects
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11.8.3 Listing strings (Text list)

The strings used in the current project are listed.
You can narrow the targets displayed in the list and jump to the location where a selected text is used.

➟■1 How to use the text list
■2 Precautions
■3 [Text List] window

■1 How to use the text list

➟(1) Listing the strings used in the project
(2) Searching for a text or jumping to the location where a selected text is used

(1) Listing the strings used in the project

Step 1 Select [Search/Replace] → [Text List] from the menu to display the [Text List] window.

➟11.8.3 ■3 [Text List] window
Step 2 After selecting any item for [Collection Target], click the [Update] button to update the text list.

Even though any text setting is changed while the [Text List] window is displayed, the text list is not 
automatically updated.
If the text list being displayed is not in the latest condition, [*] is displayed in the title bar.
Click the [Update] button to update the list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Text list

[*] indicates that the text list being displayed is not in the latest condition.
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(2) Searching for a text or jumping to the location where a selected text is used

Step 1 Display the [Text List] window.

➟(1) Listing the strings used in the project
Step 2 Select a target in which the text you search for is included for [Collection Target] and click the [Update] 

button.
Step 3 Set the text you search for in [Text] and click the [Search] button.
Step 4 The corresponding text is displayed in the text list.

Step 5 If you select a text in the text list and click the [Jump] button, a figure or an object for which the selected text 
is used is used on the screen editor.
If any text which is used for something other than figures and objects is selected, the [Jump] button is disabled.

■2 Precautions

(1) Project for which project security is set
The text used for display-disabled screens is not displayed in the [Text List] window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

The found text

Text to be searched for Starts searching.

Jump to the location where the text is used

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 [Text List] window

1) [Collection Target]
Select a target to be displayed in the text list.
After changing any text setting, click the [Update] button to update the text list.
The following shows selectable items.

• [Project]
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)
• [Parts]
• [My Library]

2) Additional condition
Select an additional condition to narrow the collection target.
The following shows selectable items.

• [All Figure/Object]
• [Text Figure]
• [Logo Text Figure]
• [Switch]
• [Lamp]
• [Bit Comment]
• [Panelmeter]
• [Graphical Meter]
• [Hyperlink] (GT27, GT25, GT SoftGOT2000, and GS25)

3) Target number
Depending on the selection for [Collection Target], the setting item differs.

• [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen]
Set a screen number as the collection target.
The setting range of [Base Screen], [Window Screen], or [Mobile Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

• [Parts]
Set a parts number as the collection target.
The setting range is [1] to [32767].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

6)

9)

7)

8)2)

3) 4)

5)
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• [My Library]
Set a library folder number as the collection target.
The setting range is [0] to [512].

4) [All screens]
Depending on the selection for [Collection Target], the setting item differs.
If you check this item, the target number is disabled.

• [Base Screen], [Window Screen], [Report Screen], and [Mobile Screen]
Sets all screens with the screen type selected in [Collection Target] as the collection target.

• [Parts]
Sets all parts as the collection target.

5) [All My Library]
Sets all library folders as the collection target.

6) [Search]
Set search conditions.

7) [Update] button
Updates the text list.
If the text list being displayed is not in the latest condition, [*] is displayed in the title bar of the [Text List] window.

8) [Jump] button
Displays the location where the text selected in the text list is used.

9) Text list
The list of the texts used in the project.
Dragging each column enables changing the width of column.

Item Description

[Text] Set a text you search for.

[Search] button Starts searching.

Item Description

[Text] Texts.

[Screen]

The screens for which the texts are used.
• [B-n]: Base screen ("n" indicates the screen number.)
• [W-n]: Window screen ("n" indicates the screen number.)
• [R-n]: Report screen ("n" indicates the screen number.)
• [M-n]: Mobile screen ("n" indicates the screen number.)
• [P-n]: Part ("n" indicates the parts number.)
• [L x n], [L x-y n]: Folder of the my library ("x" indicates the folder number which is one level 

lower than My Library. "y" indicates the folder number which is two levels lower than My 
Library. "n" indicates the data number.)

[Function] Function names for which the texts are used

[Setting] Settings for which the texts are used

[Name] Names which are set for the figures and objects

[Position] Coordinates where the figures and objects are placed
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11.8.4 Changing the set values in a batch (Batch Edit)

The settings including the device settings and the figure settings can be changed in a batch.
The following shows the settings which can be changed in a batch.

• Device, label, OMRON NJ/NX tag, AB native tag, or OPC UA tag
• Unit No. and axis No.
• Network setting (Network No., station number, and CPU No.)
• Channel No.
• Color of a figure or object
• Shape of a touch switch or lamp

The settings of different figures and objects can be changed in a batch.
Example) Changing devices in a batch

➟■1 How to use the Batch Edit
■2 Precautions
■3 [Device Batch Edit] dialog
■4 [Unit No./Axis No. Batch Edit] dialog
■5 [Network Batch Edit] dialog
■6 [CH No. Batch Edit] dialog
■7 [Color Batch Edit] dialog
■8 [Shape Batch Edit] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Base Screen 1

Word lamp
Device: D1000

Word switch
Device: GD200

Base screen 2

Numerical display
Device: D10001234

Word switch
Device: GD200

D1000 → D2000
GD200 → D200

Before
Base Screen 1

Base screen 2

After

Word lamp
Device: D2000

Numerical display
Device: D20001234

Word switch
Device: D200

Word switch
Device: D200
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■1 How to use the Batch Edit

➟(1) Changing devices in a batch
(2) Changing unit numbers and axis numbers in a batch
(3) Changing the network settings in a batch
(4) Changing channel numbers in a batch
(5) Changing the colors of figures and objects in a batch
(6) Changing the shapes of touch switches and lamps in a batch

(1) Changing devices in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [Device] from the menu to display the [Device Batch Edit] dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [Device Batch 
Edit] dialog displays the settings of the selected figures and objects in the search result list.

➟11.8.4 ■3 [Device Batch Edit] dialog
Step 2 Set [Target] and [Display Type] and click the [Find Now] button to list search results.

Step 3 In the search result list, double-click a cell in the [After] column, and set a new value.

➟6.1.2 How to set devices
Step 4 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 

column.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list
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(2) Changing unit numbers and axis numbers in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [Unit No./Axis No.] from the menu to display the [Unit No./Axis 
No. Batch Edit] dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [Unit No./Axis 
No. Batch Edit] dialog displays the settings of the selected figures and objects in the search result list.

➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog
Step 2 Set [Target] and click the [Find Now] button to display the found settings in the search result list.

Step 3 In the search result list, click a cell in the [After] column to display the setting button.
Step 4 Click the setting button to display the unit No./axis No. setting dialog.

Set a value to be applied after the batch edit, and click the [OK] button.

Step 5 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 
column.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list

Click the setting button to display the dialog.
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(3) Changing the network settings in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [Network] from the menu to display the [Network Batch Edit] 
dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [Network Batch 
Edit] dialog display the settings of the selected figures and objects in the search result list.

➟11.8.4 ■5 [Network Batch Edit] dialog
Step 2 Select a target to execute the batch edit for [Target] and click the [Find Now] button to display the found 

settings in the search result list.

Step 3 In the search result list, click a cell in the [After] column to display the setting button.
Step 4 Click the setting button to display the network setting dialog.

Set a setting value after the batch edit and click the [OK] button.

Step 5 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 
column.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list

Click the setting button to display the dialog.
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(4) Changing channel numbers in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [CH No.] from the menu to display the [CH No. Batch Edit] dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [CH No. Batch 
Edit] dialog displays the settings of the selected figures and objects in the search result list.

➟11.8.4 ■6 [CH No. Batch Edit] dialog
Step 2 Select a target to execute the batch edit for [Target] and click the [Find Now] button to display the found 

settings in the search result list.

Step 3 In the search result list, click a cell in the [After] column to display the setting button.
Step 4 Click the setting button to display the [Select CH No.] dialog.

Select a channel No. after the batch change and click the [OK] button.

Step 5 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 
column.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list

Click the setting button to display the dialog.
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(5) Changing the colors of figures and objects in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [Color] from the menu to display the [Color Batch Edit] dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [Color Batch 
Edit] dialog displays the settings of the selected figures and objects in the search result list.

➟11.8.4 ■7 [Color Batch Edit] dialog
Step 2 Select a target to execute the batch edit for [Target] and click the [Find Now] button to display the found 

settings in the search result list.

Step 3 In the search result list, click a cell in the [After] column to display the setting button.
Step 4 Click the setting button to display the color palette.

Set a color after the batch edit.
➟6.4.2 Color settings

Step 5 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 
column.
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Search result list

Click the setting button to display the dialog.
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(6) Changing the shapes of touch switches and lamps in a batch

Step 1 Select [Search/Replace] → [Batch Edit] → [Shape] from the menu to display the [Shape Batch Edit] dialog.
If you have selected figures and objects on the screen editor before selecting the menu, the [Shape Batch 
Edit] dialog displays the settings of the selected figures and objects in the search result list.

➟11.8.4 ■8 [Shape Batch Edit] dialog
Step 2 Select a target to execute the batch edit for [Target] and click the [Find Now] button to display the found 

settings in the search result list.

Step 3 In the search result list, click a cell in the [After] column to display the setting button.
Step 4 Click the setting button to display the [Image List] dialog.

The image types of figures ([Basic Figure], [Library] and [Parts]) cannot be changed.
Select a figure after the batch edit and click the [OK] button.

Step 5 Click the [Replace] button to replace the settings in the [Before] column with the settings in the [After] 
column.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list

Click the setting button to display the dialog.
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■2 Precautions

(1) Precautions for changing devices in a batch
(a) Changing devices into different device types

The devices for which the settable device types are fixed (including bit devices and word devices) cannot be changed 
into different device types.

(b) Changing consecutive devices
The start device of consecutive devices cannot be changed to a device which is out of the device range.

(c) Changing a device of the object for which the offset function is enabled
The device of the object for which the offset function is enabled cannot be changed to a bit device specified as a word 
device.

(d) Changing system labels
You cannot change a system label to the following invalid system labels.

• System labels that are not registered in the system label database
• System labels without devices assigned

(e) Changing to global labels
For collectively changing to global labels, the data type consistency check is not performed automatically between the 
global labels and the objects or others where the global labels are used.
You are recommended to check the data type consistency by comparing the contents between the device list on GT 
Designer3 and the global labels exported with GX Works3.

(f) Changing to labels (GT Designer3)
For collectively changing to labels (GT Designer3), the data type consistency check is not performed automatically 
between the labels (GT Designer3) and the objects or others where the labels (GT Designer3) are used.
You are recommended to check the data type consistency by comparing the contents between the device list on GT 
Designer3 and the labels (GT Designer3) exported with GT Designer3.
You cannot change the devices of objects or others to the following invalid labels (GT Designer3).

• Labels (GT Designer3) unregistered in label groups

(g) Changing to OMRON NJ/NX tags
For collectively changing to OMRON NJ/NX tags, the data type consistency check is not performed automatically 
between the OMRON NJ/NX tags and the objects or others where the tags are used.
You are recommended to check the data type consistency by comparing the contents between the device list on GT 
Designer3 and the OMRON NJ/NX tags exported from Sysmac Studio.

(h) Changing to AB native tags
For collectively changing to AB native tags, the data type consistency check is not performed automatically between the 
AB native tags and the objects or others where the AB native tags are used.
You are recommended to check the data type consistency by comparing the contents between the device list on GT 
Designer3 and the AB native tags exported from RSLogix 5000.

(i) Changing to OPC UA tags
For collectively changing to OPC UA tags, the data type consistency check is not performed automatically between the 
OPC UA tags and the objects or others where the OPC UA tags are used.
You are recommended to check the data type consistency by comparing the device list in GT Designer3 with the tag 
information in GT OPC UA Client.

(j) Collectively changing double-word devices
Double-word devices are collectively changed in units of two words.
When the start device number is an even number, only the devices whose device number is an even number are changed 
collectively.
When the start device number is an odd number, only the devices whose device number is an odd number are changed 
collectively.
Example)
For five double-word devices (D0 to D9), D0, D2, D4, D6, and D8 are changed collectively.
D1, D3, D5, D7, and D9 are not changed.
To collectively change word and double-word devices, select [Include the double word and quad word devices in the word 
devices] in the [Device Batch Edit] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(k) Collectively changing quad word devices
Quad word devices are collectively changed in units of four words.
Example)
For five quad word devices (D0 to D19), D0, D4, D8, D12, and D16 are changed collectively.
The other devices are not changed collectively.
To collectively change word and quad word devices, select [Include the double word and quad word devices in the word 
devices] in the [Device Batch Edit] dialog.

(l) Collectively changing the string-type labels and tags
When the string-type and non-string type devices, labels, and tags are set as the batch edit targets, the string-type labels 
and tags cannot be changed collectively.

(m) Collectively changing the string-type labels and tags
In the [Device Batch Edit] dialog, when values are directly entered in [Before] and [After] without using the [Find Now] 
button or the values are imported, the data is handled as signed 16-bit binary data.
String-type labels and tags cannot be set in these cases.
Even though the [Find Now] button is used, if string-type data and non-string type data both exist, string-type labels and 
tags may not be selected.

(2) Precautions for collectively changing module numbers and axis numbers
For the global labels imported from Motion Control Setting Function, the module numbers and axis numbers are not 
changed collectively.

(3) Precautions for changing channel numbers in a batch
If a channel No. is set for a device which does not exist in the controller after the batch edit and the CH No. Batch Edit is 
executed, the device is displayed as [??].
After changing channel numbers in a batch, check that all the devices set in the project are not displayed as [??].

(4) Precautions for using the color batch edit
When you select a shape in a given color from the system library for an object, the object is excluded from the target of 
the color batch edit.

(5) Project for which project security is set
The settings for display-disabled screens and scripts are not displayed in the batch edit dialog.

■3 [Device Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

7)

14)

8)
9)

10)

15)

3)
4)
5)
6)

11) 12) 13)
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Displays the [Device Batch Edit] dialog.
➟11.8.4 ■3 [Device Batch Edit] dialog

• [Unit No./Axis No. Batch Edit]:
Displays the [Unit No./Axis No. Batch Edit] dialog.

➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog
• [Network]:

Displays the [Network Batch Edit] dialog.
➟11.8.4 ■5 [Network Batch Edit] dialog

• [CH No.]:
Displays the [CH No. Batch Edit] dialog.

➟11.8.4 ■6 [CH No. Batch Edit] dialog
• [Color]:

Displays the [Color Batch Edit] dialog.
➟11.8.4 ■7 [Color Batch Edit] dialog

• [Shape]:
Displays the [Shape Batch Edit] dialog.

➟11.8.4 ■8 [Shape Batch Edit] dialog
2) [Project]

Searches the whole project.
3) Search target screens

The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:
Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [Device Batch Edit] dialog is opened.
This item is enabled only when figures and objects have been selected on the screen editor.

4) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

5) [Common settings (excluding settings of each screen)]
Searches the common settings.

6) [Script Text]
Searches the scripts of the specified type.
The following shows selectable items.

• [All Script]
• [Script List]

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range of [Base Screen], [Window Screen], or [Mobile 
Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

Screen type
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• [Project/Screen Script]
• [Object Script]
• [Script Parts]

7) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

8) [Display Type]
Select the display type of the search results.

• [Individual]
Lists devices individually.

• [Range]
Lists devices collectively by device type.

9) [Include the double word and quad word devices in the word devices]
Displays double-word and quad word devices in word devices, which are collectively changed in word units.

10) [Delete] button
Deletes the row selected in the search result list.

11) [Clear] button
Clears all the contents in the search result list.

12) [Import] button
Reads the device batch edit settings from a Unicode text file or CSV file.

13) [Export] button
Saves the device batch edit settings to a Unicode text file or CSV file.

➟(1) Details of the exported file
For the precautions for using a Unicode text file or CSV file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

14) Search result list
Lists the search results.
Double-clicking each cell enables changing the settings.
You can also directly set [Device], [Before], [After], and [Point] without a search to execute the batch edit.

15) [Replace] button
Executes the batch edit with the settings in the search result list.

Item Description

[Device] Device types ([Bit], [Byte], [Word], [Double Word], [Quad Word])

[Before] The setting values of the found settings

[After]

Set a device applied after the batch edit.
The setting values before the batch edit are displayed in the [After] column right after the 
searching.
Double-clicking each cell of the [After] column enables changing the devices.
If you change a device in the [After] column and then change the setting of [Display Type], 
the last-minute device change is discarded.

➟6.1.2 How to set devices

[Points]
Number of devices which are consecutively set 
In a detail setting row where a system label is set in [Before] or [After], [Points] is fixed to 
[1], and the cell color of [Points] changes to gray.
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(1) Details of the exported file
The following shows the details of the exported file of the search results.

1) [Device]
Device types.

2) [Before]
Devices before the change.

3) [After]
Devices after the change.
When [Range] is selected for [Display Type], only the start device is exported.

4) [Point]
Number of devices.

■4 [Unit No./Axis No. Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:
Displays the [Device Batch Edit] dialog.

➟11.8.4 ■3 [Device Batch Edit] dialog
• [Unit No./Axis No. Batch Edit]:

Displays the [Unit No./Axis No. Batch Edit] dialog.
➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

• [Network]:
Displays the [Network Batch Edit] dialog.

➟11.8.4 ■5 [Network Batch Edit] dialog
• [CH No.]:

1) 2) 3) 4)
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1)

8) 9)

2)
3)
4)
5)
6)

7)

10)

11)

Setting button
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Displays the [CH No. Batch Edit] dialog.
➟11.8.4 ■6 [CH No. Batch Edit] dialog

• [Color]:
Displays the [Color Batch Edit] dialog.

➟11.8.4 ■7 [Color Batch Edit] dialog
• [Shape]:

Displays the [Shape Batch Edit] dialog.
➟11.8.4 ■8 [Shape Batch Edit] dialog

2) [Project]
Searches the whole project.

3) Search target screens
The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:
Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [Unit No./Axis No. Batch Edit] dialog 
is opened.
This item is enabled only when figures and objects have been selected on the screen editor.

4) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

5) [Common settings (excluding settings of each screen)]
Searches the common settings.

6) [Script Text]
Searches the scripts of the specified type.
The following shows selectable items.

• [All Script]
• [Script List]
• [Project/Screen Script]
• [Object Script]
• [Script Parts]

7) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

8) [Delete] button
Deletes the row selected in the search result list.

9) [Clear] button

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range of [Base Screen], [Window Screen], or [Mobile 
Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

Screen type
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Clears all the contents in the search result list.
10) Search result list

Lists the search results.
Click the setting button of a cell in the [After] column to display the unit No./axis No. setting dialog.
The setting items vary according to the selected module.

You can also directly set [Network Setting], [Before], and [After] without conducting a search, and then execute the 
batch edit.
Click the setting button of a blank cell to display the [Select CH No.] dialog.

11) [Replace] button
Executes the batch edit with the settings in the search result list.

• Unit
Select a module to be routed to.

• [Unit No.]
Specify a unit number.

• [Axis No.]
Specify an axis number.

• [Axis Designation]
Specify an axis.

• [Controller Type]
Select a channel.
Click a channel button to display the network setting dialog or the 
unit No./axis No. setting dialog.
The number of channels varies by GOT model.

Item Description

[Network Setting] Current network settings of the found settings.

[Before] The setting values of the found settings

[After]
Configure the setting values after the batch edit. 
The setting values before the batch edit are displayed in the [After] column right after the 
searching.
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■5 [Network Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:
Displays the [Device Batch Edit] dialog.

➟11.8.4 ■3 [Device Batch Edit] dialog
• [Unit No./Axis No. Batch Edit]:

Displays the [Unit No./Axis No. Batch Edit] dialog.
➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

• [Network]:
Displays the [Network Batch Edit] dialog.

➟11.8.4 ■5 [Network Batch Edit] dialog
• [CH No.]:

Displays the [CH No. Batch Edit] dialog.
➟11.8.4 ■6 [CH No. Batch Edit] dialog

• [Color]:
Displays the [Color Batch Edit] dialog.

➟11.8.4 ■7 [Color Batch Edit] dialog
• [Shape]:

Displays the [Shape Batch Edit] dialog.
➟11.8.4 ■8 [Shape Batch Edit] dialog

2) [Project]
Searches the whole project.

3) Search target screens
The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [Network Batch Edit] dialog is 
opened.
This item is enabled only when figures and objects have been selected on the screen editor.

4) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

5) [Common settings (excluding settings of each screen)]
Searches the common settings.

6) [Script Text]
Searches the scripts of the specified type.
The following shows selectable items.

• [All Script]
• [Script List]
• [Project/Screen Script]
• [Object Script]
• [Script Parts]

7) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

8) [Delete] button
Deletes the row selected in the search result list.

9) [Clear] button
Clears all the contents in the search result list.

10) Search result list
Lists the search results.
Click the setting button in a cell of the search result list to display the network setting dialog.

You can also directly set [Before] and [After] without a search to execute the batch edit.

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range of [Base Screen], [Window Screen], or [Mobile 
Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

• [CPU No.]
Set a CPU No.

• [Host], [Other]
Select [Host] or [Other].
When [Other] is selected, set [Network No.] and [Station No.].

Screen type
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Click the setting button in a blank cell to display the [Select CH No.] dialog.

11) [Replace] button
Executes the batch edit with the settings in the search result list.

■6 [CH No. Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:
Displays the [Device Batch Edit] dialog.

➟11.8.4 ■3 [Device Batch Edit] dialog
• [Unit No./Axis No. Batch Edit]:

Displays the [Unit No./Axis No. Batch Edit] dialog.
➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

• [Network]:
Displays the [Network Batch Edit] dialog.

➟11.8.4 ■5 [Network Batch Edit] dialog
• [CH No.]:

Displays the [CH No. Batch Edit] dialog.
➟11.8.4 ■6 [CH No. Batch Edit] dialog

• [Color]:

• [Controller Type]
Select a channel.
Click each channel button to display the network setting dialog.
The number of channels depends on the GOT model.

Item Description

[Before] The setting values of the found settings

[After]
Configure the setting values after the batch edit. 
The setting values before the batch edit are displayed in the [After] column right after the 
searching.
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Displays the [Color Batch Edit] dialog.
➟11.8.4 ■7 [Color Batch Edit] dialog

• [Shape]:
Displays the [Shape Batch Edit] dialog.

➟11.8.4 ■8 [Shape Batch Edit] dialog
2) [Project]

Searches the whole project.
3) Search target screens

The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:
Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [CH No. Batch Edit] dialog is opened.
This item is enabled only when figures and objects have been selected on the screen editor.

4) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

5) [Common settings (excluding settings of each screen)]
Searches the common settings.

6) [Script Text]
Searches the scripts of the specified type.
The following shows selectable items.

• [All Script]
• [Script List]
• [Project/Screen Script]
• [Object Script]
• [Script Parts]

7) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

8) [Delete] button
Deletes the row selected in the search result list.

9) [Clear] button
Clears all the contents in the search result list.

10) Search result list
Lists the search results.

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range of [Base Screen], [Window Screen], or [Mobile 
Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

Screen type
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Click the setting button in a cell of the search result list to display the [Select CH No.] dialog.

You can also directly set [Before] and [After] without a search to execute the batch edit.

11) [Replace] button
Executes the batch edit with the settings in the search result list.

■7 [Color Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:
Displays the [Device Batch Edit] dialog.

➟11.8.4 ■3 [Device Batch Edit] dialog
• [Unit No./Axis No. Batch Edit]:

Displays the [Unit No./Axis No. Batch Edit] dialog.
➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog

• [Network]:
Displays the [Network Batch Edit] dialog.

➟11.8.4 ■5 [Network Batch Edit] dialog
• [CH No.]:

Displays the [CH No. Batch Edit] dialog.

• [Controller Type]
Select a channel.
The number of channels depends on the GOT model.

Item Description

[Before] The setting values of the found settings

[After]
Configure the setting values after the batch edit. 
The setting values before the batch edit are displayed in the [After] column right after the 
searching.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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➟11.8.4 ■6 [CH No. Batch Edit] dialog
• [Color]:

Displays the [Color Batch Edit] dialog.
➟11.8.4 ■7 [Color Batch Edit] dialog

• [Shape]:
Displays the [Shape Batch Edit] dialog.

➟11.8.4 ■8 [Shape Batch Edit] dialog
2) Search target screens

The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:
Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [Color Batch Edit] dialog is opened.
This item is enabled only when figures and objects have been selected on the screen editor.

3) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

4) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

5) [Delete] button
Deletes the row selected in the search result list.

6) [Clear] button
Clears all the contents in the search result list.

7) Search result list
Lists the search results.
Click the setting button in a cell to display the color palette.

➟6.4.2 Color settings

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range is [0] to [32767].

Screen type
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You can directly set [Before] and [After] and execute the batch edit without searching.

8) [Replace] button
Executes the batch edit with the settings in the search result list.

■8 [Shape Batch Edit] dialog

1) [Attribute]
Select an attribute to change in a batch.
The dialog to be displayed differs depending on the selected item.

• [Device]:
Displays the [Device Batch Edit] dialog.

➟11.8.4 ■3 [Device Batch Edit] dialog

Item Description

[Before] The setting values of the found settings

[After]
Configure the setting values after the batch edit. 
The setting values before the batch edit are displayed in the [After] column right after the 
searching.

Click the setting button to display the dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Unit No./Axis No. Batch Edit]:
Displays the [Unit No./Axis No. Batch Edit] dialog.

➟11.8.4 ■4 [Unit No./Axis No. Batch Edit] dialog
• [Network]:

Displays the [Network Batch Edit] dialog.
➟11.8.4 ■5 [Network Batch Edit] dialog

• [CH No.]:
Displays the [CH No. Batch Edit] dialog.

➟11.8.4 ■6 [CH No. Batch Edit] dialog
• [Color]:

Displays the [Color Batch Edit] dialog.
➟11.8.4 ■7 [Color Batch Edit] dialog

• [Shape]:
Displays the [Shape Batch Edit] dialog.

➟11.8.4 ■8 [Shape Batch Edit] dialog
2) Search target screens

The specified screens are searched.
The following shows selectable items.

• [All screens]:
Searches all screens.

• [Editing screen]:
Searches the screen editor displayed in the foreground.

• [Screen range]:
Searches the screens of the specified type and screen numbers.

• [Selected area]:
Searches the figures and objects selected on the screen editor before the [Shape Batch Edit] dialog is opened.
This item is enabled only when figures and objects have been selected on the screen editor.

3) [Category]
Searches the specified category.
The following shows selectable items.

• [Switch]
• [Lamp]
• [Other]
• User-created category
➟11.7 Managing figures and objects by category

4) [Search] button
Conducts a search based on the setting of [Target].
Search results are displayed in the search result list.

5) [Delete] button
Deletes the row selected in the search result list.

6) [Clear] button
Clears all the contents in the search result list.

7) Search result list
Lists the search results.
Click the setting button in a cell of the search result list to display the [Image List] dialog.
The image types of figures ([Basic Figure], [Library] and [Parts]) cannot be changed.

➟6.5.5 ■1 (3) [Image List] dialog

• Screen type
Set a screen type as the search target.
The following shows selectable items.

• [Base Screen]
• [Window Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range is [0] to [32767].

Screen type
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You can also directly set [Before] and [After] without a search to execute the batch edit.

8) [Replace] button
Executes the batch edit with the settings in the search result list.

11.8.5 Searching for and editing a specific setting (Data Browser)

The common setting, figures, and objects set in the project are displayed in a list.
You can narrow the targets displayed in the list by specifying conditions with keywords.
You can change the settings separately or in a batch in the [Data Browser] window.

➟■1 How to use the data browser
■2 Precautions
■3 [Data Browser] window
■4 [Range/Target Setting] dialog
■5 [Display Item Setting] dialog
■6 [Text Replacement] dialog
■7 Details of the exported file

■1 How to use the data browser

➟(1) Displaying the [Data Browser] window
(2) Displaying the settings in the project
(3) Changing the targets to be displayed in the data browser
(4) Changing the items to be displayed in the data browser
(5) Changing the settings displayed in the data browser separately
(6) Changing the settings displayed in the data browser in a batch
(7) Exporting the data collected in the data browser

(1) Displaying the [Data Browser] window
Perform either of the following operations to display the [Data Browser] window.
• Select [Search/Replace] → [Data Browser] from the menu.
• Select [View] → [Docking Window] → [Data Browser] from the menu.

➟11.8.5 ■3 [Data Browser] window

Item Description

[Switch Shape] Shapes set for touch switches

[Lamp Shape] Shapes set for lamps

[Before] The setting values of the found settings

[After]
Configure the setting values after the batch edit. 
The setting values before the batch edit are displayed in the [After] column right after the 
searching.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Displaying the settings in the project

The search result list in the [Data Browser] window displays the search results according to the setting of the search 
range.
Example) When [Editing screen] is selected for [Range]
When the [Data Browser] window is displayed, the settings of the screen editor displayed at the topmost position are 
displayed.

If any setting in the project is changed while the [Data Browser] window is displayed, the search result list is not 
automatically updated.
Click the [Update] button to update the search result list.

To change the targets or items displayed in the [Data Browser] window, refer to the following.
➟(3) Changing the targets to be displayed in the data browser
(4) Changing the items to be displayed in the data browser

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list

When the search result list is not 
in the latest condition

When the search result list is 
in the latest condition
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(3) Changing the targets to be displayed in the data browser

Step 1 Click the [Option] button and select [Range/Target Setting] from the pull-down menu.
The [Range/Target Setting] dialog appears.

Step 2 Set [Range] and [Target].

➟11.8.5 ■4 [Range/Target Setting] dialog
Step 3 Click the [OK] button to reflect the setting to the [Data Browser] window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Changing the items to be displayed in the data browser

Step 1 Click the [Option] button and select [Display Item Setting] from the pull-down menu.
The [Display Item Setting] dialog appears.

Step 2 Use the [Select] button and the [Delete] button to determine the items listed in [Display Items].
For the details of the operation buttons, refer to the following.
➟11.8.5 ■5 [Display Item Setting] dialog
Example 1) Setting [Object ID] as the display target

Example 2) Moving up the order of [Object ID]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Select an item to move.

Clicking the [Select] button moves the item.Select the destination to insert the item to be moved from 
[Display Options].
(The item is inserted just below the selected item.)
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Step 3 Click the [OK] button to reflect the setting to the [Data Browser] window.

(5) Changing the settings displayed in the data browser separately

Step 1 The text color of each cell in the search result list indicates whether you can edit the cell or not in the [Data 
Browser] window.
Double-click a cell whose text color is blue and edit the setting.
• When the text color is blue:

The setting can be edited in the [Data Browser] window.
Double-click each cell to edit the setting.

• When the text color is black:
The setting cannot be edited in the [Data Browser] window.
Double-click each cell to display the setting dialog.

The setting method differs depending on the setting to be edited.
Example) Changing a font

For the operation with a mouse and keyboard, refer to the following.
➟11.8.5 ■3 (1) Mouse and keyboard operations

Clicking the [Up] button moves up the item.Select an item to change the order.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(6) Changing the settings displayed in the data browser in a batch

Step 1 Select targets (rows) for which the batch edit is executed in the search result list.
Multiple rows can be selected by either of the following methods.
• [Shift] + click:

Selects the rows from the row where the cursor is positioned to the row where the mouse is clicked.
• [Ctrl] + Click

Selects or deselects a row.
• [Shift] + Arrow (Up/Down):

Moves the cursor while selecting the row where the cursor was placed.
The destination row of the cursor is also selected.

The figures and objects corresponding to the rows selected in the search result list are selected on the screen 
editor.

Step 2 Click the [Option] button, and select [Device Batch Edit], [Text Batch Edit], [Color Batch Edit], or [Shape 
Batch Edit] from the pull-down menu.
The batch edit dialog to change each setting appears.
Example) When the [Text Batch Edit] is selected from the menu

Step 3 Set each item in the displayed dialog and click the [Replace] button to execute the batch edit with the 
configured settings.
• [Device Batch Edit] dialog
➟11.8.4 ■3 [Device Batch Edit] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Text Replacement] dialog
➟11.8.5 ■6 [Text Replacement] dialog
• [Color Batch Edit] dialog
➟11.8.4 ■7 [Color Batch Edit] dialog
• [Shape Batch Edit] dialog
➟11.8.4 ■8 [Shape Batch Edit] dialog

Step 4 Click the [OK] button to close the batch edit dialog.
Step 5 Click the [Update] button to update the search result list.

(7) Exporting the data collected in the data browser

Step 1 Click the [Option] button and select [Export] from the pull-down menu.
The [Save As] dialog appears.

Step 2 Set [File name] and [Save as type] and click the [Save] button to export the search result list.

➟11.8.5 ■7 Details of the exported file

■2 Precautions

(1) The operations which cannot be restored by [Undo]
The settings which were changed by either of the following operations cannot be restored even though [Edit] → [Undo] 
is selected from the menu.
Before changing the settings, check the contents to be changed.
• Changing the settings with the Text Batch Edit, Device Batch Edit, or Color Batch Edit
• Changing the settings of the figures and objects placed on a screen editor which is not opened
• Changing the common setting

(2) The settings which cannot be edited while the corresponding screen is closed
Some settings (including the settings of X-coordinates, Y-coordinates, and logo texts) cannot be edited while the 
corresponding screens are closed.
If you change those settings in the [Data Browser] window, open a screen on which the figures and objects to be edited 
are placed.

(3) Project for which project security is set
When editing the project is prohibited, the settings cannot be changed in the [Data Browser] window.
The settings for display-disabled screens and scripts are not displayed in the [Data Browser] window.
Although the settings for edit-disabled screens and scripts are displayed in the [Data Browser] window, the settings 
cannot be changed and deleted.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Changing the settings of [Range Setting] and [Input Range Setting]
When you directly enter any item shown below for [Range Setting] or [Input Range Setting], enclose the item in square 
brackets.
• Device name with only numbers
• OPC UA tag name
A name that is not enclosed in square brackets will not be recognized as a device or OPC UA tag.
Example) Specifying the device (2000000) of the SHARP equipment for [Range Setting]

■3 [Data Browser] window

1) [Update] button
Updates the search result list.
The display of the [Update] button differs depending on the status of the search result list.

2) [Option] button
Operates the [Data Browser] window from the pull-down menu.

Device : 2000000Constant : 2000000

Item Description

[Range/Target Setting]
Displays the [Range/Target Setting] dialog. 
Set a target to be displayed in the search result list.

➟11.8.5 ■4 [Range/Target Setting] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2) 3) 4) 5)

6)

When the search result list is not 
in the latest condition

When the search result list is 
in the latest condition
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3) [Refinement]
Narrows the displayed contents of the search result list by keywords.
Up to 128 characters can be set.
To narrow the contents using multiple keywords, separate each keyword with one-byte spaces.

4) [Range]
Range selected in [Range] of the [Range/Target Setting] dialog

5) [Search Result]
The number of the targets displayed in the search result list

6) Search result list
Displays the search result.
Clicking the top row sorts the results by item.
If you select a row, the corresponding figure or object is also selected on the screen editor.
You can edit the settings of some items.
The text color of each cell indicates whether you can edit the cell or not in the [[Data Browser] window.

• When the text color is blue:
The setting can be edited in the [Data Browser] window.
Double-click each cell to edit the setting.
The setting method differs depending on the setting to be edited.

• When the text color is black:
The setting cannot be edited in the [Data Browser] window.
Double-click each cell to display the setting dialog.

For the operations with the mouse or keyboard, refer to the following.
➟(1) Mouse and keyboard operations

(1) Mouse and keyboard operations

(a) Operations for the list display
The following table shows how to operate the search result list in the [Data Browser] window with the mouse or keyboard.

[Display Item Setting]
Displays the [Display Item Setting] dialog. 
Set an item to be displayed in the search result list.

➟11.8.5 ■5 [Display Item Setting] dialog

[Device Batch Edit]
Displays the [Device Batch Edit] dialog. 
The device settings selected in the search result list can be edited in a batch.

➟11.8.4 ■3 [Device Batch Edit] dialog

[Text Batch Edit]
Displays the [Text Batch Edit] dialog. 
The text settings selected in the search result list can be edited in a batch.

➟11.8.5 ■6 [Text Replacement] dialog

[Color Batch Edit]
Displays the [Color Batch Edit] dialog. 
The color settings selected in the search result list can be edited in a batch.

➟11.8.4 ■7 [Color Batch Edit] dialog

[Shape Batch Edit]
Displays the [Shape Batch Edit] dialog. 
The shape settings selected in the search result list can be edited in a batch.

➟11.8.4 ■8 [Shape Batch Edit] dialog

[Export]
Saves the search result list as a CSV file or a Unicode text file. 
Set [File name] and [Save as type] in the displayed dialog and click the [Save] button.

➟11.8.5 ■7 Details of the exported file

Item Description

Operation Action

Arrow (Up/Down/Left/
Right) Moves the cursor.

[Shift] + Arrow (Up/Down/
Left/Right)

Move the cursor while selecting the cell with the cursor. 
The cell to which the cursor is moved is also selected.

[+] (Numeric keypad) Unfolds the tree of the row with the cursor.

[-] (Numeric keypad) Folds the tree of the row with the cursor.

[Shift] + [+] (Numeric 
keypad) Unfolds all the trees.

[Shift] + [-] (Numeric 
keypad) Folds all the trees.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(b) Operations when a cell is edited
The following table shows the keyboard operation for when a cell in the search result list is edited.

[Home] Moves the cursor to the top row.

[End] Moves the cursor to the bottom row.

[PageUp] Moves the cursor up one page.

[PageDown] Moves the cursor down one page.

[Shift] + [Home] Selects the rows from the row where the cursor is positioned to the top row.

[Shift] + [End] Selects the rows from the row where the cursor is positioned to the bottom row.

[Shift] + [PageUp] Selects the rows from the row where the cursor is positioned to the row where the cursor moves up one page.

[Shift] + [PageDown] Selects the rows from the row where the cursor is positioned to the row where the cursor moves down one page.

[Shift] + Click Selects the rows from the row where the cursor is positioned to the row where the mouse is clicked.

[Ctrl] + [Space]
Selects or deselects a row.

[Ctrl] + Click

[Tab] Moves the cursor to the right cell.

[Shift] + [Tab] Moves the cursor to the left cell.

[Enter] Moves the cursor downward by one row.

[Alt] + [Enter]
Displays the setting dialog for the figure or object corresponding to the row with the cursor.

[F3]

[Ctrl] + [C]

• When selecting a cell in the [Item] column
The figure or object corresponding to the selected row is copied.
When multiple cells are selected, only the figures and objects placed on the same screen editor are copied.

• When selecting a cell in a column other than the [Item] column
The setting value of the cell with the cursor is copied.
When multiple cells are selected, the setting values of all the selected cells are copied.

[Ctrl] + [X] Cuts the figure or object corresponding to the row with the cursor.

[Ctrl] + [V]

• When copying a cell in the [Item] column
The copied figure or object is pasted on the screen editor.

• When copying a cell in a column other than the [Item] column
The copied text is pasted on the cell with the cursor.
The value which is out of the setting range cannot be pasted.

[Ctrl] + [D] Pastes a copy of the figure or object corresponding to the row with the cursor on the screen editor.

[Ctrl] + [A] Selects all the figures and objects placed on the screen editor displayed at the topmost position.

[Ctrl] + [U] Cancels the grouping of the figures and objects corresponding to the rows with the cursor.

[Delete] Clears the value in the cell with the cursor. (This operation is available for the cells for which can be edited directly.) 
Clearing the items for which numerical values are set makes the setting values to zero.

[Back space]
Enables the cell where the cursor was placed to be edited. 
When the cell which can be edited directly is selected, the setting value is cleared and editing is enabled.

➟(b) Operations when a cell is edited

Character keys
When a cell which can be edited directly is selected with the cursor, editing the cell is enabled by inputting any 
character with the keys.

➟(b) Operations when a cell is edited

[F2]
Enables the cell where the cursor was placed to be edited. 
You can edit only the cells whose text color is blue.

➟(b) Operations when a cell is edited

Double-click

• Any cell whose text color is blue
Enables the cell to be edited.

• Any cell other than above
Double-clicking a cell displays the setting dialog for a figure or an object corresponding to the selected cell.

➟(b) Operations when a cell is edited

Drag Selects multiple cells.

Operation Action

[Enter] Confirms and ends the edit.

[Esc] Discards and ends the edit.

[Tab] Confirms the edit and moves the cursor to the right cell.

[Shift] + [Tab] Confirms the edit and moves the cursor to the left cell.

Operation Action
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■4 [Range/Target Setting] dialog

1) [Range]
Selects the range to be displayed in the [Data Browser] window.
The following shows selectable items.

2) [Target]
Set the target to be displayed in the [Data Browser] window.

3) [Select All button
Selects all the items in [Target].

4) [Deselect] button
Deselects all the items in [Target].

5) [Maximum number of display items]
Sets the maximum number of data to be displayed in the search result list.

[Alt] + [Enter] Inserts a line feed when text is input.

Operation Action

Item Description

[All screens] Searches all screens.

[Editing screen]

Searches the screen editor displayed in the foreground.
• [Automatically update the list when displaying screens/Data Browser]

Updates the display contents of the [Data Browser] window upon any of the following operations.
·Displaying or switching a screen editor
·Displaying the [Data Browser] window hidden by the auto-hiding function

[Screen range]

Searching is performed for the specified screens only.

• Screen type
Set a screen type as the search target.
The following shows selectable items.
• [Base Screen]
• [Window Screen]
• [Report Screen]
• [Mobile Screen] (GT27, GT25, GT SoftGOT2000, and GS25)

• [From], [To]
Set the range of the screen numbers to search.
The setting range of [Base Screen], [Window Screen], or [Mobile Screen] is [0] to [32767].
The setting range of [Report Screen] is [1] to [99].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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The setting range is [1] to [10000].

■5 [Display Item Setting] dialog

1) [Option Refinement]
Narrows the items displayed in [Display Options].

2) [Display Options]
Options of the items displayed in the search result list
Select an item and click the [Select] button to move the item to [Display Items].
To narrow down the list, enter a string in the search field.
To sort the list in ascending or descending order, click the [Sort] button.

3) Operation buttons

4) [Display Items]
Items to be displayed in the search result list
If any item is selected and the [Delete] button is clicked, the selected item is moved to [Display Options].
The items in the search result list are displayed in the order set for [Display Items].

If any item is selected and the [Up] button or the [Down] button is clicked, the position of the selected item is moved 
upward or downward.

Item Description

[Select] button Moves the item selected in [Display Options] to [Display Items].

[Delete] button Moves the item selected in [Display Items] to [Display Options].

[Up] button, [Down] button Move the item selected in [Display Items] upward or downward.

[Select All] button Moves all the items in [Display Options] to [Display Items].

[Delete All] button Moves all the items other than [Item] in [Display Items] to [Display Options].

[Reset] button Restores the items in [Display Items] to the default ones.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4)2)

3)[Sort] button

Search field

The first item
The second item

The third item

The first item The second item The third item...
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■6 [Text Replacement] dialog

1) [Find what]
Set a text before the replacement.
Up to 512 characters can be set.
Capital letters and small letters are distinguished.

2) [Replace with]
Set a text after the replacement.
Up to 512 characters can be set.
Capital letters and small letters are distinguished.

3) [Replace] button
The text set in [Find what] is replaced with the text set in [Replace with].

■7 Details of the exported file

The following shows the details of the exported file of the corrected data in the data browser.

1) [Target]
Target to be displayed in the [Data Browser] window

2) [Range]
Target to be displayed in the [Data Browser] window

3) Item
Item set in the [Display Item Setting]
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11
11.8.6 Checking the IP addresses in the list (IP address list)

The IP addresses registered in the project are displayed in the list.
You can narrow your search, or jump to an IP address setting window.

➟■1 IP addresses to be displayed
■2 How to use the IP address list
■3 [IP Address List] window
■4 [Display Item Setting] dialog (IP address list)

■1 IP addresses to be displayed

The IP addresses are displayed in the IP address list depending on the settings as shown below.

*1 Not displayed when a DNS server is used and the POP3 server is specified with the host name in the mail settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Displayed Not displayed

• [GOT Setup] window ([Time Setting])
• [GOT Setup] window ([Network Drive])
• [GOT Ethernet Setting] window ([GOT IP Address Setting])

• [Controller Setting] window*1

• [Multimedia] dialog
• [Printer] dialog
• [GOT Network Interaction] dialog
• [Communication Configuration] dialog (the IP address of the PLC 

side I/F only)

• [MES Interface] dialog
• [Switch] dialog
• [Special Function Switch] dialog

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 How to use the IP address list

➟(1) Displaying the IP addresses registered in a project
(2) Changing the items to be displayed in the IP address list
(3) Changing an IP address displayed in the IP address list
(4) Exporting the search results displayed in the IP address list

(1) Displaying the IP addresses registered in a project
Perform one of the following operations to display the [IP Address List] window.

• Select [Search/Replace] → [IP Address List] from the menu.
• Select [View] → [Docking Window] → [IP Address List] from the menu.
• Click the [IP Address List] button on the toolbar.

➟■3 [IP Address List] window

The search result list in the [IP Address List] window displays the search results according to the items selected for 
display.
For selecting the items to be displayed, refer to the following.

➟(2) Changing the items to be displayed in the IP address list

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Search result list
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(2) Changing the items to be displayed in the IP address list
Step 1 Click the [Option] button in the [IP Address List] window and select [Display Item Setting] from the pull-down 

menu to display the [Display Item Setting] dialog.

Step 2 Select the items to be displayed in the [IP Address List] window, and specify their display order.
For details on the operation buttons, refer to the following.

➟■4 [Display Item Setting] dialog (IP address list)

(3) Changing an IP address displayed in the IP address list
Step 1 Double-click the row of the IP address to be changed in the search result list in the [IP Address List] window 

to display its setting window.

Step 2 Edit the setting and click the [OK] button to apply the new setting.

(4) Exporting the search results displayed in the IP address list
Step 1 Click the [Option] button and select [Export] from the pull-down menu to display the [Save As] dialog.
Step 2 Set [File name] and [Save as type] and click the [Save] button to export the search result list.
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■3 [IP Address List] window

1) [Option] button
Select a setting item from the pull-down menu.

2) [Refinement]
Narrows the displayed contents of the search result list by keywords.
Up to 128 characters can be set.
To narrow the contents using multiple keywords, separate each keyword with one-byte spaces.

3) [Reset Sort]
Changes the sorting order of [Controller/Setting Name] to the order of GT Designer3 menus.

4) [Search Result]
The number of the targets displayed in the search result list.

5) Search result list
Displays the search result.
Click the item name to sort the list by the item.
Colored cells represent the following.

• Yellow:
The IP address has already existed in the project.
If the IP address is the same as one of the IP addresses that are not displayed in the list, the cell is not colored 
in yellow.
➟■1 IP addresses to be displayed

• Green:
The IP address is set using MELSOFT Navigator.

(1) Mouse and keyboard operations
The following shows the mouse and keyboard operations for the search result list in the [IP Address List] window.

[Display Item Setting]
Displays the [Display Item Setting] dialog.
Select the items to be displayed in the search result list.

➟■4 [Display Item Setting] dialog (IP address list)

[Export]
Saves the search result list as a CSV file or a Unicode text file.
Set [File name] and [Save as type] in the displayed dialog and click the [Save] button to 
export the search result list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
2) 4)1)

5)

3)

Operation Action

Arrow (Up/Down/Left/Right) Moves the cursor.

[Home] Moves the cursor to the top row.

[End] Moves the cursor to the bottom row.

[PageUp] Moves the cursor up one page.

[PageDown] Moves the cursor down one page.

[Enter] Moves the cursor downward by one row.

[Ctrl] + [Space] Selects or deselects a row.

Double-click

Displays the setting window corresponding to the row where the cursor is positioned.[Alt] + [Enter]

[F3]
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11
■4 [Display Item Setting] dialog (IP address list)

1) [Display Options]
Options of the items displayed in the search result list.
Select an item and click the [Select] button to move the item to [Display Items].
To narrow down the list, enter a string in the search field.
To sort the list in ascending or descending order, click the [Sort] button.

2) Operation buttons

3) [Display Items]
Items to be displayed in the search result list.
If any item is selected and the [Delete] button is clicked, the selected item is moved to [Display Options].
The items in the search result list are displayed in the order set for [Display Items].

If any item is selected and the [Up] button or the [Down] button is clicked, the position of the selected item is moved 
upward or downward.

Item Description

[Select] button Moves the item selected in [Display Options] to [Display Items].

[Delete] button Moves the item selected in [Display Items] to [Display Options].

[Up] button, [Down] button Move the item selected in [Display Items] upward or downward.

[Select All] button Moves all the items in [Display Options] to [Display Items].

[Delete All] button Moves all the items other than [Controller/Setting Name] in [Display Items] to [Display 
Options].

[Reset] button Restores the items in [Display Items] to the default ones.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

Search field

[Sort] button

The first item
The second item

The third item

The first item The second item The third item...
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11.9 Checking and Editing Settings of Screens and Objects (Property 
Sheet)

The list of attributes and set values of a selected screen, figure, or object can be displayed.
Settings can be checked or changed without opening the setting dialog.
Example) Selecting a word lamp

Set values can be changed collectively by selecting multiple figures or objects on the same screen.
Example) Collectively changing the width and height of bit switches

➟11.9.1 Specifications of the property sheet
11.9.2 How to use the property sheet
11.9.3 Precautions
11.9.4 [Property] window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.9.1 Specifications of the property sheet

■1 Targets for the display of the [Property] window
The following shows the targets for displaying the list of attributes in the [Property] window.
• Base screen
• Window screen
• Report Screen
• Mobile Screen
• Figure
• Object
• Template
When multiple figures and objects on the same screen are selected, the attributes of them are displayed on the same sheet.
When a group is selected, all the grouped figures and objects are identified as the targets for the property sheet.

■2 Batch change of attributes
The batch change is applicable to the attributes that are common to the selected figures or objects.

■3 Width and height of a figure or object
The following shows the setting ranges of the width and height of a figure or object.

In the [Property] window, the width and height of a grouping of figures or objects are not changeable.

11.9.2 How to use the property sheet

Step 1 Click [View] → [Docking Window] → [Propertysheet] from the menu to display the [Property] window.
In the default setting, the [Property] window is docked with GT Designer3.
➟11.9.4 [Property] window

Step 2 Select the target screen, figure, or object to display the attributes of the target in the [Property] window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Setting range

[Width] [1] to [2000]

[Height] [1] to [1600]
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[Property] window
11. USEFUL FUNCTIONS
11.9 Checking and Editing Settings of Screens and Objects (Property Sheet)

11 - 163



Step 3 To change an attribute, change the set value in the attribute list of the [Property] window.
The method of setting each attribute is the same as that applied to each setting dialog.
Example) Changing the color

11.9.3 Precautions

■1 Batch change performed when multiple targets are selected
A change of a set value in the [Property] window is reflected in the attribute of all the selected figures and objects.
To avoid an unintentional change, select only the targets that need the change.

■2 Shape settings of objects
In the [Property] window, the shape of objects cannot be changed to [None].
Change the shape of objects to [None] in the setting dialog for each object if necessary.

11.9.4 [Property] window

1) Display target
Displays the target that gets its attributes displayed in the [Property] window.

2) [Unfold All] button

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11
Expands all attribute items.
3) [Fold All] button

Collapses all attribute items.
4) [Template Property] button

Appears when a template information box is selected.
Switches the [Property] window to the one for template attributes.

➟11.6.6 [Property] window (when the template property is displayed)
5) Attribute list

Lists the attributes the target has had.
The contents displayed depend on the target.

• Base screens, window screens, report screens and mobile screens
The same contents as those in the [Basic] tab in the [Screen Property] dialog are displayed.

• Figures and objects
The coordinates (X, Y), size (width, height), and the same contents as those in each setting dialog are displayed.

• Templates
The template attributes are displayed.

➟11.6.6 [Property] window (when the template property is displayed)

If multiple figures and objects on the same screen are selected, certain attributes can be changed collectively.
If multiple different figures and objects are selected, the attribute list is displayed as follows.

• If a figure is included in the selection
The attribute list is displayed on the basis of the attributes of the figure in the back most layer.

• If no figure is included in the selection
The attribute list is displayed on the basis of the attributes of the object of the smallest object ID number.

If the set values of attributes common to multiple selected figures and objects differ among the figures and objects, 
the fields of the set values turn blank.
The attributes that cannot be changed are displayed with the text color in gray.

When a word lamp is selectedWhen a base screen is selected
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11.10 Customizing GT Designer3

➟11.10.1 Customizing the toolbar
11.10.2 Customizing the docking window
11.10.3 Customizing the operation
11.10.4 Customizing the settings related to editing operations
11.10.5 Customizing the display
11.10.6 Customizing the default value
11.10.7 Interaction with iQ Works

11.10.1 Customizing the toolbar

The position of the toolbars for GT Designer3 can be changed and a toolbar can be created in collecting frequently used 
functions.

➟■1 Changing the position of toolbars
■2 Adding/deleting buttons to/from a toolbar
■3 Resetting toolbars
■4 Creating toolbars
■5 Deleting toolbars
■6 [Customize] dialog

For the details of toolbar types and the method of switching between displaying and hiding toolbars, refer to the following.
➟2.2.2 Toolbar and shortcut keys

■1 Changing the position of toolbars

Step 1 When the mouse cursor is moved over the left end of the toolbar to move, the shape of the mouse cursor 
changes as shown below.

Step 2 Drag the toolbar to the destination while holding it clicked. The toolbar moves.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Adding/deleting buttons to/from a toolbar

➟(1) Adding buttons
(2) Deleting buttons

(1) Adding buttons

Step 1 Select [Tools] → [Customize] from the menu to display the [Customize] dialog.
Step 2 Select [Category] in the [Command] tab and drag the command to add from [Command] to the toolbar to 

which the corresponding button is added.
The button corresponding to the dragged command is added.

➟11.10.1 ■6 (2) [Command] tab
Step 3 When you have completed making necessary changes, close the [Customize] dialog.

Changes made to the default toolbars can be reset in the [Toolbar] tab.
➟11.10.1 ■6 (1) [Toolbar] tab

(2) Deleting buttons

Step 1 Select [Tools] → [Customize] from the menu to display the [Customize] dialog.
Step 2 While the [Customize] dialog is displayed, drag out of the toolbar the button to delete from the toolbar.

The dragged button is deleted.

Step 3 When you have completed making necessary changes, close the [Customize] dialog.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Resetting toolbars

Step 1 Select [Tools] → [Customize] from the menu to display the [Customize] dialog.
Step 2 Select the toolbar to reset in the [Toolbar] tab and click the [Reset] button to reset the toolbar.

Only the default toolbars can be reset.

Step 3 When you have completed making necessary changes, close the [Customize] dialog.

■4 Creating toolbars

Step 1 Select [Tools] → [Customize] from the menu to display the [Customize] dialog.
Step 2 Click the [New] button in the [Toolbar] tab to display the [New Toolbar] dialog.

Step 3 Set [Toolbar name] and click the [OK] button to create a new toolbar.
Add buttons in the [Command] tab.
➟11.10.1 ■2 (1) Adding buttons

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■5 Deleting toolbars

Step 1 Select [Tools] → [Customize] from the menu to display the [Customize] dialog.
Step 2 Select the toolbar to delete in the [Toolbar] tab and click the [Delete] button to display the toolbar.

Only the toolbars created by a user can be deleted.

Step 3 When you have completed making necessary changes, close the [Customize] dialog.

■6 [Customize] dialog

➟(1) [Toolbar] tab
(2) [Command] tab

(1) [Toolbar] tab

1) [Toolbars]
Lists the toolbars.
Switches between displaying and hiding each toolbar.

2) [New] button
Displays the [New Toolbar] dialog.
Creates a new toolbar.

3) [Rename] button
Displays the [Rename Toolbar] dialog.
Changes the name of the toolbar selected in [Toolbars].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• [Toolbar name]
Set the name of the toolbar to create.
Up to 255 characters can be set.
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The names of the default toolbars cannot be changed.

4) [Delete] button
Deletes the toolbar selected in the [Toolbars].
The default toolbars cannot be deleted.

5) [Reset] button
Resets the contents of the toolbar selected in [Toolbars] to the initial status.
Only the default toolbars can be reset.

(2) [Command] tab

1) Category I
Lists the categories of commands.
Switches the contents displayed in [Command].

2) [Command]
Display the commands to add to the toolbars.
Drag a command to a toolbar to add a button in the toolbar.

• [Toolbar name]
Set the new name of the toolbar used after the change.
Up to 255 characters can be set.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.10.2 Customizing the docking window

With this function, the position of docking windows can be changed and multiple docking windows can be combined into a 
single window.
Docking windows can be displayed or hidden as required.
Customized docking windows are saved and retained for the next startup.
If project security is set, customized docking windows are saved by user.

➟■1 Screen layout of the docking windows
■2 Changing the position of docking windows

For the details of docking window types, and the method of switching between displaying and hiding the docking windows, 
refer to the following.

➟2.2 Screen Layout of GT Designer3
2.2.2 Toolbar and shortcut keys

■1 Screen layout of the docking windows

The following shows the screen layout common to the docking windows.
Example) [Category List] window

1) Title bar
Displays the title of the docking window.
Drag this bar to display the docking guide on the screen.

➟11.10.2 ■2 (1) Docking
2) Autohide button

The contents of the docking window are displayed only when the mouse cursor is moved over the title bar of the 
docking window.

3) Docking tabs
Switches docking windows.
The tabs are displayed when docking windows are docked.
To extract a docking window from the dock window, drag the corresponding tab out of the dock window.

■2 Changing the position of docking windows

➟(1) Docking
(2) Extracting docking windows from a dock window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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1)

2)

3)

: Autohide is enabled.

: Autohide is disabled.
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(1) Docking

Example) Docking the [Category List] window with the main screen.
Step 1 Drag the title bar of the docking window to dock over the main screen to display the docking guides.

The following shows the types of the docking guides.
• Inner guide (Right/Left/Up/Down)

Docks the window in a position nearer to the center than where the other docking windows have been already 
docked.

• Tab guide
Appears in the center of the inner guide when the docking window is dragged over another docking window.
Docks the docking window with another docking window.

• Outer guide (Right/Left/Up/Down)
Docks the window in a position farther from the center than where the other docking windows have been 
already docked.

Step 2 Move the mouse cursor over a docking guide while dragging the docking window over to display the 
indication of the position where the docking window is placed when it is docked.

Step 3 Drop the window while the mouse cursor is on the docking guide to dock the docking window.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Outer guide
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Tab guide

Position to be placed
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Step 4 Enable autohide with the autohide button to display the tab of the docking window.

➟11.10.2 ■1 Screen layout of the docking windows
Place the mouse cursor over the tab to display the docking window.

To change the size of the docking window, place the mouse cursor over and drag the docking window frame.

(2) Extracting docking windows from a dock window

Step 1 Disable autohide of the docking window with the autohide button.

➟11.10.2 ■1 Screen layout of the docking windows
Step 2 Drag the corresponding tab or the title bar out of the dock window to extract the docking window from the 

dock window.
Double-clicking the title bar or the tab also extracts the window.

A docking window has been docked.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.10.3 Customizing the operation

You can customize settings related to the operations of GT Designer3.
Step 1 Select [Tools] → [Option] from the menu to display the [Options] dialog.
Step 2 Change the settings of the [Operation] tab and click the [OK] button to get the settings reflected.

➟■1 [Option] dialog ([Operation] tab)

■1 [Option] dialog ([Operation] tab)

1) [Display the project selection dialog when the application is activated]
Displays the [Select Project] dialog at the startup of GT Designer3.

➟2.1.1 Starting GT Designer3
2) [Display New Project Wizard]

Displays the wizard for a new project when it is created.
➟2.3.1 ■1 Using the wizard

3) [Perform type setting at the time of creating a new project]
Displays the [Type Setting] dialog when a project is created.
When the [Display New Project Wizard] is selected, this operation is disabled.

➟2.3.1 ■2 Without using the wizard
4) [Close the first edited screen before opening another one when the number of open screens is at 

its maximum]
Closes the first-opened screen when a new editor is opened after the number of screen editors being opened reaches 
its maximum.
The setting is enabled at the next start-up of GT Designer3.

5) [Behavior when window screen preview (overlap, superimpose) is double-clicked]
Select what will appear when the window position objects for the following window screens are double-clicked on 
base screens.

• Overlap window

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Max] Set the maximum number of screens which can be opened. 
The setting range is [1] to [25].
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• Superimpose window
The following shows the items to be selected.

• [Open the editing screen]
Displays the screen editor for the window screen.

• [Open the window preview setting]
Displays the [Window Preview] dialog.

If a window screen preview is not displayed for the placed window position object, double-clicking the object 
displays the [Window Preview] dialog regardless of what is selected.

The [Window Preview] dialog is displayed by one of the following operations as well.
• Select [Display] → [Window Preview] → [Setting] from the menu.
• Right-click a window position object on a base screen, and select [Setting].
• Select a window position object on a base screen, and press the [Alt] key and the [Enter] key simultaneously.

6) [Display the dialog of Communication Setting before displaying the dialog of Communicate with 
GOT/GOT Diagnostics]
Displays the [Communication Configuration] dialog before displaying the [Communicate with GOT] dialog or the [GOT 
Diagnostics] dialog.

7) [Restructure the project data at the time of next data save]
Deletes unnecessary data from a project data to reduce the project data size when the project data is saved.
After the project data is saved, this item is automatically deselected.
Therefore, this setting is not maintained after the project data is saved.
When restructuring the project data, note the following.

• If the personal computer, which the project data is saved and restructured in, does not have Windows fonts used 
in the project data, each Windows font is changed to the default font of each object.

• The verification results of the project data before and after a restructuring may have inconsistencies.
• When the restructured project data is written to the GOT again, all the screen data are rewritten.

8) [Redisplay the new feature announcement] button
Redisplays the dismissed [New Feature Announcement] dialog.
This item appears when [Do not show this message again] is selected in the [New Feature Announcement] dialog.
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11.10.4 Customizing the settings related to editing operations

Customize the settings related to editing operations on GT Designer3.
Step 1 Select [Tools] → [Option] from the menu to display the [Options] dialog.
Step 2 Customize the settings on the [Edit] tab and click the [OK] button to apply changes.

➟■1 [Options] dialog ([Edit] tab)

■1 [Options] dialog ([Edit] tab)

1) [Place figures/objects sequentially]
Retains the control of the arrangement mode after a figure or an object is placed. The same figure or object can be 
placed repeatedly without selecting it from the menu.
To cancel the arrangement mode, right-click or press the [ESC] key.

2) [Deselect figures/objects once they are placed]
Deselects figures and objects after they are placed.

3) [Display the setting dialog once figures/objects are placed]
Displays the setting dialog automatically every time a figure or an object is placed.

4) [Move figures/objects in the screen display area (move to temporary area with the Alt key)]
Limits the area where figures and objects can be placed to the screen display area on the screen editor.
If figures and objects are operated while the [ALT] key is pressed, they can be also placed in the temporary area.

5) [Adjust the touch area to be smaller than its object size by 1-dot at the time of touch area self-
adjust]
Reduces the touch area to be inside the object area at the time of the touch area self-adjustment. The edge of the 
touch area becomes 1 dot away from the edge of the object area.
For the touch area self-adjustment, refer to the following.

➟6.6.14 [Edit Touch Area]
6) [Turn off IME at the time of device input]

Disables IME to enter only one-byte characters to specify a device.
7) [CH No. Selection Dialog Display Setting]

Select whether to display or hide the [Select CH No.] dialog at the device setting.
The [Select CH No.] dialog is displayed when two or more channels are set.

➟6.1.2 How to set devices
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The following shows selectable items.
• [Display only when setting new device]

Displays the [Select CH No.] dialog only when a device is newly set.
• [Always display]

Always displays the [Select CH No.] dialog at the device setting.
• [Not display (Display the dialog of specified CH No.)]

Does not display the [Select CH No.] dialog at the device setting.
Displays the device setting dialog of the channel set for [CH No.].

8) [Reflect the data type of label]
Makes date types of objects or others reflect those of the following labels used in the device setting.

• System label
• Label (GT Designer3)

For the correspondence of data types between the system labels and the devices on GT Designer3, refer to the 
following.

➟6.1.3 ■2 Applicable system labels
9) [Display a warning when a system label that is not array/string type is set for the continuous 
device setting]

Displays a message when the [Import] button is clicked in the [Import System Labels to Project] dialog if a non-
array-type or non-string-type system label is set for any of consecutive devices.

10) [Setting] button
Displays the [Setting] dialog.
Select whether to reflect a number change to the related common settings and object settings.

➟■2 [Setting] dialog (for customizing the settings related to editing operations)

Item Description

[CH No.]

Set these items when [Not display (Display the dialog of specified CH No.)] is selected. 
The following shows selectable items.
• [System Label]: Displays the [Import System Labels to Project] dialog.
• [Label (GT Designer3)]: Displays the [Select Label (GT Designer3)] dialog.
• [Global Label]: Displays the [Select Global Label] dialog.
• [OMRON NJ/NX Tag]: Displays the [Select OMRON NJ/NX Tag] dialog.
• [OPC UA Tag]: Displays the [Select OPC UA Tag] dialog.
• [1], [2], [3], [4]: Displays the device setting dialog of a set channel.
• [Latest]: Displays the device setting dialog of the same channel as that of the latest device 

setting.
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■2 [Setting] dialog (for customizing the settings related to editing operations)

1) [Comment Group No.], [Comment No.], and [Parts No.]
Select whether to reflect a number change to the related common settings and object settings if the registered 
number of the following items are changed.

• Comment group
• Comment
• Part

The following shows selectable items.
• [Always reflect]

Reflects a number change to the related common settings and object settings.
• [Not reflect]

Does not reflect a number change to the related common settings and object settings.
• [Display the confirmation message]

Displays a confirmation dialog with each number change.
Select whether to reflect a number change to the related common settings and object settings.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
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11.10.5 Customizing the display

You can customize the settings related to the display of GT Designer3.
Step 1 Select [Tools] → [Option] from the menu to display the [Options] dialog.
Step 2 Change the setting of the [View] tab and click the [OK] button to get the setting reflected.

➟■1 [Options] dialog ([View] tab)

■1 [Options] dialog ([View] tab)

1) [Snap]
Select the interval (in dots) between figures and objects when they are placed or moved on the screen editor.
The following shows selectable items.

• [1]
• [2]
• [4]
• [8]
• [16]

2) [Grid]
Set the position and the distance between the lines of the grid on the screen editor.
The grid is set not for each project but for GT Designer3. The customized grid is enabled regardless of the project to 
be opened.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Position]

Select the display position of the grid. 
The following shows selectable items.
• [Front]
• [Back]
• [None]

[Spacing] Set the grid spacing (in dots). 
The setting range is [2] to [64] dots.

[Color]
Select the grid color.

➟6.4.2 Color settings

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

5)

6)

3)

4)
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3) [Two-point Press Inactive Area]
Set the display position and the color of the two-point press inactive area on the screen editor.
Only GT27 is supported.
To enable the two-point touch on the GOT, the touched points must be in different two-point press inactive areas.
Place the points for the two-point touch in different two-point press inactive areas.

➟8.2.3 ■2 (1) Simultaneous 2-point press

4) [Scroll Bar Area]
Available to GT27, GT25, and GS25.

This item is available when [Expand base screen sizes] is selected in [Basic Setting] in the [Type Setting] dialog.
Set the display position and color of the following items on the screen editors for the expanded base screens.

• Solid lines representing the scroll bar areas
• Dotted lines representing partitions for GOT screens

This item is not settable if the scroll bars are set to be hidden on the expanded base screens.
For details on the base screen size expansion, refer to the following.

➟5.1.3 ■2 Screen editors for editing the expanded base screens

5) [Display Item]
Set the information to be displayed on the screen editor.

Item Description

[Position]

Select the display position of the two-point press inactive area. 
The following shows selectable items.
• [Front]
• [Back]
• [None]

[Color]
Select the color of the two-point press inactive area

➟6.4.2 Color settings

Item Description

[Position]

Select the display position of the lines.
The following shows selectable items.
• [Front]
• [Back]
• [None]

[Color]
Select the color of the lines.

➟6.4.2 Color settings

Item Description

[Paint] Displays a color on the area to be filled.

[Object ID] Displays the object ID numbers on the objects.

[Object] Displays the objects on the screen editor.

[Object Frame] Displays the object frames on the screen editor.

[Template Information] Displays the template Information on the screen editor.

[Device]

Displays the set devices on the objects. 
The display type can be selected. 
The following shows selectable items.
• [Short]: Displays devices only. (For labels (GT Designer3): Displays label names only.)
• [Full]: Displays channel numbers, network numbers, station numbers, CPU numbers, and 

devices. (For labels (GT Designer3): Displays label group names and label names.)
Click the [Type Selection] button to display the [Type Selection] dialog. 
Whether to display or hide the devices other than monitor devices and display colors can 
be set.

➟■2 [Type Selection] dialog

[Device of Label]
Displays the devices assigned to the following labels on objects.
• System label
• Label (GT Designer3)

GOT Graphic Ver.2
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6) Color setting
Set a text color and background color.

➟6.4.2 Color settings

■2 [Type Selection] dialog

1) [Monitor Device]
Displays the monitor devices on the objects.
This item cannot be deselected.
Select the text background color of the devices.

2) [Lamp Device of Switch]
Displays the devices set for the lamp function of touch switches.
Select the text background color of the devices.

3) [Trigger Type]
Displays the devices set as display conditions or operating conditions
Select the text background color of the devices.

Item Description

[Device/Object ID Text Color] Select the text color of the devices and object ID numbers displayed on the objects.

[Device Text Background Color]

Select the text background color of the devices displayed on the objects. 
Click the [Color Selection] button to display the [Type Selection] dialog. 
Whether to display or hide the devices other than monitor devices and display colors can 
be set.

➟■2 [Type Selection] dialog

[Object ID Text Background Color] Select the text background color of the object ID numbers displayed on the objects.

[Object Frame Color] Select the display color of the object frames.

[Editor Background Color]

• [Parts]
Select the background color of the parts editor.

• [Library]
Select the background color of the library editor.

[Template Information Background Color] Select the background color of the template information.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)
2)
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11.10.6 Customizing the default value

Default values are values preset for placed figures or objects.
By setting frequently used values as the default values, drawings can be efficiently executed.

➟■1 How to use default values
■2 [Option] dialog ([Default Setting] tab)

■1 How to use default values

➟(1) Changing default values in the [Option] dialog
(2) Setting the values set for edited figures and objects as the default values
(3) Canceling changes and resetting the default values to the initial values
(4) Exporting the default values
(5) Importing the default values

(1) Changing default values in the [Option] dialog

Step 1 Carry out either of the following operations to display the [Option] dialog.
• Select [Tools] → [Default Setting] → [Edit] from the menu.
• Select [Tools] → [Option] from the menu.

Step 2 Select the target for the change of the default value in [Figure/Object] of the [Default Setting] tab and click 
the [Edit] button.

➟11.10.6 ■2 [Option] dialog ([Default Setting] tab)
Example) Setting the default value of switches

Step 3 Displays the setting dialog for the target selected in [Figure/Object].
Set a default value and click the [OK] button

Step 4 Click the [OK] button in the [Option] dialog to complete changing the default value.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Setting the values set for edited figures and objects as the default values

The following shows how to set the values set for a figure/an object as the default values.
Step 1 Place a figure or an object on the screen editor and change the settings in the setting dialog or others.

➟6.5.1 Placing figures and objects
Step 2 Select the figure or the object and [Edit] → [Set to Default] from the menu to set the values set for the figure 

or object as the default values.

(3) Canceling changes and resetting the default values to the initial values

Step 1 Carry out either of the following operations to display the [Option] dialog.
• Select [Tools] → [Default Setting] → [Edit] from the menu.
• Select [Tools] → [Option] from the menu.

Step 2 Carry out either of the following operations.
• Resetting default values to the initial values by figure/object

Select the target for resetting the default value in [Figure/Object] in the [Default Setting] tab and click the 
[Reset] button.

• Resetting the default values of all the figures and objects to the initial values
Click the [Reset All] button in the [Default Setting] tab.

Step 3 Click the [OK] button in the [Option] dialog to complete changing the default value.

(4) Exporting the default values

Step 1 Select [Tools] → [Default Setting] → [Export] from the menu to display the [Save As] dialog.
Step 2 Set [File name] and [Save as type] and click the [Save] button to export the default value setting.

(5) Importing the default values

Step 1 Select [Tools] → [Default Setting] → [Import] from the menu to display the [Open Default Setting File] dialog.
Step 2 Set [File name] and [Save as type] and click the [Open] button to import the default value setting.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 [Option] dialog ([Default Setting] tab)

1) [Figure/Object]
Lists figures and objects.
For the items of figures and objects that have got the default values changed, [*] is displayed to the right of the names.
When an item is double-clicked, the setting dialog is displayed as it is displayed when the [Edit] button is clicked.

2) [Edit] button
Displays the setting dialog of the figure/object selected in [Figure/Object].
The items for which no default value can be set are displayed in gray.
After changing settings, click the [OK] button to change the default value.

3) [Reset] button
Resets the default value of the figure/object selected in [Figure/Object] to the initial value.

4) [Reset All] button
Resets the default value of all the figures and objects to the initial values.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)
3)

4)
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11.10.7 Interaction with iQ Works

You can change the settings related to the operations of GT Designer3 in interaction with MELSOFT Navigator.
Step 1 Select [Tools] → [Option] from the menu to display the [Options] dialog.
Step 2 Change the settings of the [iQ Works Interaction] tab and click the [OK] button to get the settings reflected.

➟■1 [Option] dialog ([iQ Works Interaction] tab)

■1 [Option] dialog ([iQ Works Interaction] tab)

1) [Enable an editing of parameters set in MELSOFT Navigator]
Allows edits to be performed on the parameters reflected from MELSOFT Navigator by GT Designer3.
When editing the parameters reflected from MELSOFT Navigator, make the same changes to the settings for 
MELSOFT Navigator.
If the settings differ between MELSOFT Navigator and GT Designer3, the GOT may not communicate with controllers 
after package data are transferred to the GOT.
In this case, match the settings for MELSOFT Navigator with those for GT Designer3 using verification between 
parameter reflection/system configuration information and parameters, provided by MELSOFT Navigator.
For how to use MELSOFT Navigator, refer to the following.

➟Help on MELSOFT Navigator
2) [Automatically perform if there is a change in the referenced system label]

If there is a change in the system label being referred when a project is opened, updates the system label 
automatically.

3) [Input Assist Display Column]
Of the comment set for a system label Ver.2, select the column to be displayed on the input assist.
The following shows selectable items.

• [Comment]
• [Comment2]
• [Comment3]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Display the confirmation dialog prior to the 
execution] Displays the confirmation dialog before system labels are automatically updated.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2)

1)

3)
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• [Comment4]
• [Comment5]
• [Comment6]
• [Comment7]
• [Comment8]
• [Comment9]
• [Comment10]
• [Comment11]
• [Comment12]
• [Comment13]
• [Comment14]
• [Comment15]
• [Comment16]

Editing the parameters reflected from MELSOFT Navigator
When editing the parameters reflected from MELSOFT Navigator, make the same changes to the settings 
for MELSOFT Navigator.
If the settings differ between MELSOFT Navigator and GT Designer3, the GOT may not communicate with 
controllers after package data are transferred to the GOT.
In this case, match the settings for MELSOFT Navigator with those for GT Designer3 using verification 
between parameter reflection/system configuration information and parameters, provided by MELSOFT 
Navigator.
For how to use MELSOFT Navigator, refer to the following.

➟Help on MELSOFT Navigator
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11.11 Checking Data Size

The data size of created screens or projects can be checked.
➟11.11.1 Checking the data size of a screen
11.11.2 Checking data size of project

For the relationship between the GOT storage memory (ROM)/operation memory (RAM) and the data to be transferred, 
refer to the following.

➟12.10 Data Transferred to the GOT and Storage Destination

11.11.1 Checking the data size of a screen

Step 1 Select the screen to check the data size.
Step 2 Select [Tools] → [Data Size] → [Screen] from the menu to display the [Data Size (Screen)] dialog.

Check the data size.
➟■1 [Data Size (Screen)] dialog

■1 [Data Size (Screen)] dialog

1) [Current Screen]
Displays the type of the screen being edited and the associated number.

2) [Title]
Displays the title of the screen being edited.

3) [Data Size]
Displays the data size of the screen.
For GT21 and GS21, the size of screen data that has been expanded in the GOT operation memory (RAM) is 
displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Storage Memory (ROM)] Displays the data size of the screen saved in the GOT storage memory (ROM).

[Operation Memory (RAM)] Displays the data size of the screen expanded in the GOT operation memory (RAM).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

3)

2)

For GT21, and GS21
11. USEFUL FUNCTIONS
11.11 Checking Data Size

11 - 187



11.11.2 Checking data size of project

Select [Tools] → [Data Size] → [Project] from the menu to display the [Data Size (Project)] dialog.
Check the data size.

➟■1 [Data Size (Project)] dialog

■1 [Data Size (Project)] dialog

1) [Title]
Displays the title of the project.

2) [Data Size]
Displays the data size of the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[Storage Memory (ROM)] This item appears for GT27, GT25, GT23, GT SoftGOT2000, and GS25.
The data size of the project saved in the GOT storage memory (ROM) is displayed.

[Operation Memory (RAM)] This item appears for GT27, GT25, GT23, GT SoftGOT2000, and GS25.
The data size of the project expanded in the GOT operation memory (RAM) is displayed.

[Project Data] This item appears for GT21 and GS21. 
The data size of the project data is displayed.

[Buffering Area] This item appears for GT21 and GS21. 
The data size of the project saved in the buffering area is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

GT27, GT25, GT23, GT SoftGOT2000, and GS25 GT21, and GS21

1)

2)
11 - 188 11. USEFUL FUNCTIONS
11.11 Checking Data Size



U
SE

FU
L 

FU
N

C
TI

O
N

S

11
11.12 Zooming and Scrolling the Monitor Screen of the GOT (Screen 
Gesture Function)

Zoom and scroll the screen while the user-created screen on the GOT is displayed.
Even though many objects are arranged on the screen, erroneous operation can be preventive by zooming the screen.

Zoom and scroll the screen after switching to the screen gesture mode.
The operation for the objects is not available except part of area of the screen during the screen gesture mode.

➟11.12.1 Specification of the screen gesture function
11.12.2 How to use the screen gesture function (setting with GT Designer3)
11.12.3 How to use the screen gesture function (operating with the GOT)
11.12.4 Relevant settings
11.12.5 Precautions

11.12.1 Specification of the screen gesture function

➟■1 Screen gesture mode
■2 Applicable screens to the screen gesture mode
■3 Switching to and cancelling the screen gesture mode
■4 Zooming and scrolling the screen
■5 Displaying a screen during the screen gesture mode
■6 Effect on other functions

■1 Screen gesture mode

Using the screen gesture mode to zoom and scroll the monitor screen of the GOT
Zooming and scrolling the screen are available only on the area applied to the screen gesture.
Switch to the screen gesture mode to display the frame for the area applied to the screen gesture.

The frame colors indicate which section of the enlarged screen is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Area applied to the screen gesture

Area not applied to the screen gesture

Screen gesture mode
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(1) Area applied to the screen gesture
The area to zoom and scroll the screen
The operation for the objects on the area applied to the screen gesture is not available.
The status of zooming and scrolling the screen during the screen gesture mode is kept even after the screen gesture 
mode is cancelled.
Switch the screen to reset the status of zooming and scrolling the screen.

(2) Area not applied to the screen gesture
The area in which operating objects is enabled even in the screen gesture mode. Zooming and scrolling the screen are 
not available in this area.
The height of the area is 32 dots from the top edge of the screen by default. The height and position of the area are 
changeable.
To operate an object in the screen gesture mode, place the object in the screen gesture inactive area.
For how to set the screen gesture inactive area, refer to the following.

➟2.7.1 ■1 [Basic] tab

■2 Applicable screens to the screen gesture mode

The following shows the applicable screens to the screen gesture mode.
• Base screen
• Superimpose window (only when it is displayed on the base screen.)
• Called screen (only when it is displayed on the base screen.)
Whether the screen gesture function is available or not is set by the project.
(The superimpose window and the called screen are applied to whether they are available for the destination screen to be 
displayed or not.)

➟11.12.2 ■1 Enabling the screen gesture function

■3 Switching to and cancelling the screen gesture mode

➟(1) Switch to the screen gesture mode.
(2) Cancel the screen gesture mode.

(1) Switch to the screen gesture mode.

The following operation can switch to the screen gesture mode.
• Touch the key code switch.

➟11.12.2 ■2 Arranging the switch for switching to the screen gesture mode
　 11.12.3 ■1 Switching the mode of the GOT to the screen gesture mode

(2) Cancel the screen gesture mode.

The screen gesture mode is cancelled by the operation and at the timing as follows.
• Touch the key code switch.

➟11.12.2 ■2 Arranging the switch for switching to the screen gesture mode
　 11.12.3 ■1 Switching the mode of the GOT to the screen gesture mode

Full scale view Enlarged view Displayed section of the enlarged
screen on the GOT

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• Display the utility.
• Switch the screen (change of the screen switching device value).
• Display the system dialog.

■4 Zooming and scrolling the screen

➟(1) Zoom the screen.
(2) Scroll the screen.

(1) Zoom the screen.
The following operation can zoom the screen during the screen gesture mode.
• Pinch in and pinch out the screen.

➟11.12.3 ■2 Zooming the screen of the GOT

(2) Scroll the screen.
The following operation can scroll the screen during the screen gesture mode.
• Flick and slide the screen.

➟11.12.3 ■3 Scrolling the screen of the GOT

■5 Displaying a screen during the screen gesture mode

➟(1) Displaying a base screen
(2) Displaying a superimpose window and a called screen
(3) Displaying an overlap window
(4) Displaying a key window

(1) Displaying a base screen

Entering the screen gesture mode displays the frame for the screen gesture active area.
When the value of the screen switching device changes during such an operation as pinching in or flicking the screen, a 
screen switching occurs when the user releases the finger from the screen of the GOT.
The screen switching exits the screen gesture mode and resets the zoomed or scrolled screen.

(2) Displaying a superimpose window and a called screen

A superimpose window and a called screen that belong to a base screen are handled as part of the base screen.
When the base screen is zoomed or scrolled, the superimpose window and the called screen are also zoomed or scrolled.
Even though a screen switching occurs on the superimpose window, the zoomed or scrolled state is kept.

(3) Displaying an overlap window

Entering the screen gesture mode hides overlap windows.
Exiting the screen gesture mode redisplays the overlap windows at their original positions.
Zooming or scrolling the screen does not work on overlap windows.
Zooming or scrolling the screen does not change the value of the display position specification device of the overlap 
windows either.
Example) Exiting the screen gesture mode while overlap window 1 is displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Displaying a key window

Entering the screen gesture mode hides key windows.
Exiting the screen gesture mode does not redisplay the key windows.

■6 Effect on other functions

➟(1) Numerical input and character string input
(2) Video/RGB display object
(3) Function for displaying the popup display
(4) Hard copy
(5) Remote personal computer operation (Serial)
(6) VNC server function
(7) Video display function and multimedia function
(8) Operation Log
(9) SoftGOT-GOT link function
(10) GOT internal device to notify the touch status of the GOT
(11) Screen save

(1) Numerical input and character string input
When the mode is switched to the screen gesture mode during the numerical input and character string input, the input 
contents are canceled.

(2) Video/RGB display object
The input image is not displayed in the screen gesture mode.
To display the image, clear the screen gesture mode.
If the video/RGB display object overlaps the screen gesture inactive area, the input image is not displayed as well.

(3) Function for displaying the popup display
Popup display under the alarm popup display, VNC server function, SoftGOT-GOT link function, and others is also made 
during the screen gesture mode.
The display position switching is also available with a touch at the left edge of the popup display.
The display position is corrected so as not to overlap the area not applied to the screen gesture.
Example) Screen gesture inactive area set on the top edge of the screen

Exiting the screen gesture mode

Zooming in the screen Exiting the screen gesture mode

Overlap window 1

Overlap window 1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) Hard copy
When the hard copy is performed with the GOT screen zoomed or scrolled, the zoomed or scrolled screen is output.

(5) Remote personal computer operation (Serial)
Even though RGB screen (screen of personal computer) is touched with the screen zoomed or scrolled, the touched 
position is not sent to the personal computer correctly.
When using the remote personal computer operation function (Serial), do not use zooming and scrolling the screen while 
RGB screen (personal computer screen) is displayed on the GOT.

(6) VNC server function
While a VNC client (such as a personal computer) is communicating with a VNC server (GOT), when the client obtains 
the authorization of the VNC server function, the screen gesture mode is canceled and the zoomed or scrolled screen is 
reset.
While the VNC client has the authorization, the GOT is not switched to the screen gesture mode.

(7) Video display function and multimedia function
The image input from the external device is not displayed during the screen gesture mode.
Cancel the screen gesture mode to display the image.
Zooming and scrolling the screen is not applied.

(8) Operation Log
The operation log includes switching to and cancelling the screen gesture mode.
The operation log does not include the operations during the screen gesture mode.

(9) SoftGOT-GOT link function
Even though switching to the screen gesture mode or, zooming and scrolling the screen is performed on the GOT, GT 
SoftGOT2000 communicating with the GOT is unaffected.

(10)GOT internal device to notify the touch status of the GOT
The following shows the action of the GOT internal device to notify the touch status of the GOT while the screen gesture 
function is used.
• Touch Status External Notification (X-coordinate) (GS654) and Touch Status External Notification (Y-coordinate) 
(GS655)
They are not operated during the screen gesture mode.
Cancel the screen gesture mode and touch the area applied to the screen gesture of the zoomed or scrolled screen to 
notify the coordinate applied to the zoomed or scrolled the screen.

• Touch Status External Notification (Touch Status) (GS656)
It is not operated during the screen gesture mode.

(11)Screen save
Even though the status of the GOT is changed to the status of the screen save during the screen gesture mode, the 
screen gesture mode is kept.

Area not applied to the screen gesture

Popup display (Upper, Middle, Bottom)
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11.12.2 How to use the screen gesture function (setting with GT Designer3)

➟■1 Enabling the screen gesture function
■2 Arranging the switch for switching to the screen gesture mode

■1 Enabling the screen gesture function

The screen gesture function is enabled by default.
(In common with the object gesture function)
If the screen gesture function is not enabled, configure the setting according to the following procedure.

Step 1 Select [Common] → [GOT Type Setting] from the menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
Step 2 Select [Use the gesture function] and click the [OK] button.

The screen gesture function is enabled.

To smooth the operations, also select [Enable the graphics accelerator to smooth the screen gesture and 
document display operations].
Enabling the graphics accelerator may increase the GOT startup time.
In the screen gesture mode, the object display is not refreshed.

Step 3 Set the switching method to the screen gesture mode.

➟■2 Arranging the switch for switching to the screen gesture mode

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Arranging the switch for switching to the screen gesture mode

Even though the switch for switching to the screen gesture mode is arranged on the screen where using the screen gesture 
function is not set, the switch cannot be operated.
Configure the setting for using the screen gesture function.

➟■1 Enabling the screen gesture function
Step 1 Select [Object] → [Switch] → [Key Code Switch] from the menu to arrange a key code switch in the screen 

gesture inactive area on the screen, which uses the screen gesture function.

➟6.5.1 Placing figures and objects

The position and size of the screen gesture inactive area are settable on the [Basic] tab in the [Screen Property] 
dialog.
To display the frame of the screen gesture inactive area on the screen editor, select [Display the screen gesture 
inactive area].
➟2.7.1 ■1 [Basic] tab

Step 2 Double-click the arranged key code switch to display the setting dialog.
Step 3 Set the following and click the [OK] button to complete the setting.

• Select [Screen Gesture] in [Key Code Type].
• Select [Screen gesture mode switching] in [Code Setting].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Area not applied to the screen gesture

Arrange the key code switch.
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11.12.3 How to use the screen gesture function (operating with the GOT)

➟■1 Switching the mode of the GOT to the screen gesture mode
■2 Zooming the screen of the GOT
■3 Scrolling the screen of the GOT

■1 Switching the mode of the GOT to the screen gesture mode

Touch the switch for switching the mode to switch to the screen gesture mode.
Switch to the screen gesture mode to display the frame for the area applied to the screen gesture.

Touch the switch for switching the mode during the screen gesture mode to cancel the screen gesture mode.

■2 Zooming the screen of the GOT

Pinch in the screen to zoom out the screen and pinch out the screen to zoom in the screen.
Zooming out the screen is available to the screen in the zoomed-in the screen.

(1) Zoom out (pinch in) the screen.
Step 1 Touch two positions as the center of the area to be zoomed out on the GOT screen.
Step 2 Pinch in the screen by the finger toward the center of the two positions to zoom out the screen in the center 

of the two positions.

The screen cannot be zoomed out with less than the original size of the screen.
Display update of the object is cancelled during the operation.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Area applied to the screen gesture
Switch for switching the mode

Screen gesture mode
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(2) Zoom in (pinch out) the screen.
Step 1 Touch two positions as the center of the area to be zoomed in on the GOT screen.
Step 2 Pinch out the screen by the fingers from the center of the two positions outward to zoom in the screen in the 

center of the two positions.

The screen can be zoomed in up to four times of the screen with the original size.
The screen might blur by zooming in the screen.
Display update of the object is cancelled during the operation.

(3) Full scale display
Touch the key code switch having the following settings to return the GOT screen to the actual size (100%) and to cancel 
the screen gesture mode.
• [Screen Gesture] is selected for [Key Code Type].
• [Full scale display (100%)] is selected in [Code Setting].
Arrange the key code switch used in the screen gesture mode in the screen gesture inactive area.

➟11.12.2 ■2 Arranging the switch for switching to the screen gesture mode

■3 Scrolling the screen of the GOT

Flick or slide the screen of the GOT to scroll the screen.

(1) Flick the screen.
Flick the screen to scroll the screen.

(2) Slide the screen.
Move a figure with the figure touched on the screen to scroll the screen.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.12.4 Relevant settings

Set the relevant settings other than the specific settings for the screen gesture function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

11.12.5 Precautions

■1 Arranging the switch for switching to the screen gesture mode
The objects arranged in the area applied to the screen gesture cannot be operated during the screen gesture mode.
When the switch for switching the mode is arranged to the area applied to the screen gesture, after switching to the screen 
gesture mode, the mode cannot be cancelled by the switch for switching the mode.
Arrange the switch for switching the mode to the area not applied to the screen gesture.

➟11.12.2 ■2 Arranging the switch for switching to the screen gesture mode

■2 Combination with the remote personal computer operation function (Serial)
Even though RGB screen (screen of personal computer) is touched with the screen zoomed or scrolled, the touched position 
is not sent to the personal computer correctly.
When using the remote personal computer operation function (Serial), do not use zooming and scrolling the screen while 
RGB screen (personal computer screen) is displayed on the GOT.

■3 Operating the GOT with a mouse
When the GOT is operated using a mouse with the USB mouse, the keyboard function, the VNC server function, and others, 
zooming the screen by pinching in or pinching out the screen cannot be performed.

■4 Base screen size expansion
The screen gesture function is disabled when the base screen size expansion is enabled.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Enabling the gesture function [Use the gesture function]

Smoothing the operations of the screen gesture function
[Enable the graphics accelerator to smooth the screen gesture and 
document display operations]

GOT Graphic Ver.1
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11.13 Operating Objects by the Gesture (Object Gesture Function)

Scroll or zoom in and out the displayed contents of the objects by the gesture such as the flick.
Example) Scroll the contents with the flick.

➟11.13.1 Specifications of the object gesture function
11.13.2 How to use the object gesture function (setting with GT Designer3)
11.13.3 How to use the object gesture function (operation with the GOT)
11.13.4 Relevant settings

11.13.1 Specifications of the object gesture function

➟■1 Objects operated by the gesture
■2 Type of the gesture

■1 Objects operated by the gesture

The following shows the applicable functions to the object gesture function.
• Historical data list display
• Alarm display (user)
• Alarm display (system)
• Simple alarm display
• Historical trend graph
• Document display
• Video/RGB display object

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■2 Type of the gesture

The following shows the gesture used with the object gesture function.
• Flick
• Slide
• Pinch in
• Pinch out
The operation of the object by touch is not related to the setting of the object gesture function.
Whether displaying a cursor is enabled or not while the object is touched depends on the setting for the one-touch operation 
with each object.

(1) Flick
Flick your finger on the screen.

(2) Slide
Drag your finger across the screen.

(3) Pinch in
Touch two positions and pinch in the screen by the fingers toward the center of the two positions.

(4) Pinch out
Touch two positions and pinch out the screen by the fingers from the center of the two positions outward.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.13.2 How to use the object gesture function (setting with GT Designer3)

➟■1 Enabling the object gesture function

■1 Enabling the object gesture function

The object gesture function is enabled by default.
(In common with the screen gesture function)
If the object gesture function is not enabled, configure the setting according to the following procedure.

Step 1 Select [Common] → [GOT Type Setting]Menu to display the [Type Setting] dialog.

➟5.1.5 [Type Setting] dialog
Step 2 Select [Use the gesture function] and click the [OK] button.

The object gesture function is enabled.
The GOT operates as shown below during gesture operations.

• The object display is not refreshed during gesture operations.
• The document display appears in the foreground while you operate it by gestures.

(Overlap windows and key windows appear behind the document display.)

To operate the video/RGB display object with the gesture operation, set the item as shown below.
• Select [Gesture Operation (Scaling/Scrolling)] for [Touch Mode] on the [Video/RGB Setting] tab in the 

[Video/RGB Display] dialog.
➟8.27.4 ■1 [Video/RGB Setting] tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.13.3 How to use the object gesture function (operation with the GOT)

➟■1 Operating the historical data list display
■2 Operating the alarm display (user), alarm display (system), and simple alarm display
■3 Operating the historical trend graph
■4 Operating the document display
■5 Operating the video/RGB display object

■1 Operating the historical data list display

➟(1) Scroll

(1) Scroll

Flick the historical data list display to scroll the displayed contents upward and downward.
One flick scrolls the display for a half page.

• Flick the display upward. 
The display is scrolled downward.

• Flick the display downward. 
The display is scrolled upward.

Example) Scroll the display downward.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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2013/4/11 09:00
2013/4/11 10:00
2013/4/11 11:00
2013/4/11 12:00

Date and time

2013/4/11 13:00

100
150
200
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A

300

B
100
125
150
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2013/4/11 12:00
2013/4/11 13:00
2013/4/11 14:00
2013/4/11 15:00

Date and time

2013/4/11 16:00

250
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400

A

450

B
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225
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■2 Operating the alarm display (user), alarm display (system), and simple alarm display

➟(1) Scroll

(1) Scroll

Flick the alarm display (user), alarm display (system), and simple alarm display to scroll the displayed contents upward 
and downward.
One flick scrolls the display for a half page.

• Flick the display upward. 
The display is scrolled downward.

• Flick the display downward. 
The display is scrolled upward.

Example) Scroll the display downward.

■3 Operating the historical trend graph

➟(1) Scroll
(2) Zooming in and out time axis

(1) Scroll

Flick the historical trend graph to scroll the displayed contents.
One flick scrolls the display for a half page.
A direction of the flick depends on the setting of [Direction] of the historical trend graph.

(a) When selecting [Right] or [Left] with the [Direction] of the historical trend graph
• Flick the display leftward. 

The display is scrolled rightward.
• Flick the display rightward. 

The display is scrolled leftward.

(b) When selecting [Up] or [Down] with the [Direction] of the historical trend graph
• Flick the display upward. 

The display is scrolled downward.
• Flick the display downward. 

The display is scrolled upward.
Example) Scroll the display rightward.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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4/10 09:35
4/10 15:05
4/11 11:22
4/11 16:16

Occurred

4/11 21:49

Abnormal tempe
Fuse error
Abnormal tempe
Hydraulic pressu

Comment

Hydraulic pressu

4/11 16:16
4/11 21:49
4/12 10:51
4/14 18:37

Occurred

4/15 14:09

Hydraulic pressu
Hydraulic pressu
Abnormal tempe
Abnormal tempe

Comment

Fuse error
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(2) Zooming in and out time axis

Pinch in or out the historical trend graph to zoom out or in time axis each.
The details of pinch-out and pinch-in operations are settable in [Magnification for scaling operation] in the [Historical 
Trend Graph] dialog ([Extended] tab).

➟8.21.4 ■4 [Extended] tab
You can enlarge the time axis until the graph displays two points.
The scope of reducing the time axis varies with the setting of [Shrink the graph to be less than its full scale].
When [Shrink the graph to be less than its full scale] is selected, the time axis can be reduced to a magnification of 1/128.
When [Shrink the graph to be less than its full scale] is deselected, the time axis can be reduced to the original 
magnification.
Example) Zoom in time axis.

■4 Operating the document display

➟(1) Scroll
(2) Next page and previous page
(3) Zooming in and out the document

(1) Scroll

Flick or slide your finger on the document display to scroll the document.
The document display can be scrolled in eight directions as follows.

Example) Scroll the display leftward.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Next page and previous page

Flick the display with the edge of the document displayed to change the page.

(a) When displaying the upper end of the document
Flick the page downward to change to the previous page. (Previous page)

(b) When displaying the bottom end of the document
Flick the page upward to change to the next page. (Next page)

(c) When displaying the left end of the document
Flick the page rightward to change to the previous page. (Previous page)

(d) When displaying the right end of the document
Flick the page leftward to change to the next page. (Next page)
Example) Next page

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) Zooming in and out the document

Pinching in or out the document display reduces or enlarges the document size.
Example) Zoom in the document.

The zoom behavior when the document display is pinched out or in varies depending on the document type.
➟8.26.6 [Document Display] dialog

• When the document type is set to [Document Converter Output File]
Pinching in or out the document display switches the document size to large, medium, or small.
One pinch in zooms out the displayed document by one size smaller than the current display size.
One pinch out zooms in the displayed document by one size larger than the current display size.

• When the document type is set to [PDF File]
Pinching in or out the document display reduces or enlarges the document size to a size at 25% to 400% 
magnification.

The zoom behavior when the document display is pinched out or in varies depending on the document type and the 
graphics accelerator setting.

➟5.1.5 [Type Setting] dialog
8.26.6 [Document Display] dialog

• When the document type is set to [Document Converter Output File] and the graphics accelerator is disabled
Pinching in or out the document display switches the document size to large, medium, or small.
One pinch in zooms out the displayed document by one size smaller than the current display size.
One pinch out zooms in the displayed document by one size larger than the current display size.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Document display
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(Full scale)
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• When the document type is set to [PDF File] or when the document type is set to [Document Converter Output File] 
and the graphics accelerator is enabled
Pinching in or out the document display reduces or enlarges the document size to a size at 25% to 400% 
magnification.

■5 Operating the video/RGB display object

Not available to GT2705-V.
➟(1) Scrolling the displayed image

(2) Enlarging or reducing the displayed image

(1) Scrolling the displayed image

To scroll the displayed image, slide your finger across the video/RGB display object.

200%25% 100%
(Full scale)

400%

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(2) Enlarging or reducing the displayed image

To reduce or enlarge the displayed image (25% to 400%), pinch in or out on the video/RGB display object.

11.13.4 Relevant settings

Set the relevant settings other than the specific settings for the object gesture function as required.
The following shows the functions that are available by the relevant settings.

■1 GOT type settings
Select [Common] → [GOT Type Setting] from the menu to display the [GOT Type Setting] dialog.

➟5.1.5 [Type Setting] dialog

■2 GOT internal device
➟12.1 GOT Internal Device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Reduce Enlarge

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Function Setting item

Enabling the gesture function [Use the gesture function]

Smoothing the operations of the screen gesture function
[Enable the graphics accelerator to smooth the screen gesture and 
document display operations]

GOT Graphic Ver.1

Function Setting item

Disabling the object gesture function GS1794.b0

Disabling the single touch operation of the object GS1794.b1
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11.14 Checking the Causes and Corrective Actions for an Error in the GOT 
(GOT Diagnostics)

GT Designer3 obtains system status log data from the GOT.
The causes and corrective actions for an error are displayed.
You can monitor the GOT internal devices and change the device values as necessary.

➟11.14.1 Specifications of the GOT diagnostics
11.14.2 How to use the GOT diagnostics
11.14.3 GOT internal device monitor
11.14.4 Precautions
11.14.5 [GOT Diagnostics] dialog
11.14.6 [GOT Internal Device Monitor] window

11.14.1 Specifications of the GOT diagnostics

■1 GOT diagnostics display target
The GOT diagnostics function displays the following items.
• System alarm (GOT error, CPU error, and network error)
• Script error (Project script, screen script, and object script)

■2 Version of the standard system application
To perform the GOT diagnostics, the GOT requires a standard system application version 01.10.*** or later.
To perform the GOT internal device monitor, the GOT requires a standard system application version 01.20.*** or later. 
(Version 01.22.*** or later for GT21 and GS21)
For information on how to check the version of the standard system application, refer to the following.

➟GOT2000 Series User's Manual (Utility)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Displaying the causes and corrective actions for an error

System status log
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■3 Format of a saved file
The following shows the format of a saved file containing error information.
Example) CSV file

1) Date and time on the GOT
GOT date and time on which GT Designer3 obtained the last system log data

2) Date and time on the personal computer
Personal computer date and time on which error information was saved to a file

3) Connected GOT
Type and name of the connected GOT

4) [Communication path]
Communication path between the personal computer and the GOT

5) [No.]
Number indicating the order of displaying errors

6) [Occurrence Date]
Date and time on which an error occurred

7) [Category]
Error category

8) [CH No.]
Number of the channel where an error occurred

9) [Error Code]
Error code for a system alarm or script error

10) [Overview]
Details of a system alarm or script error

11) [Cause]
Causes of an error

12) [Corrective Action]
Corrective actions for an error

1) 2)

12)11)10)7)6)5) 8) 9)

3) 4)
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11.14.2 How to use the GOT diagnostics

➟■1 Obtaining system status log data from the GOT and displaying error information
■2 Saving the contents of the error list to a file

■1 Obtaining system status log data from the GOT and displaying error information
Step 1 Connect the GOT to the personal computer.

For the communication path types, refer to the following.
➟4.1.1 Route for the data transfer

For the connection method, refer to the following.
➟4.3.1 Connecting the personal computer to the GOT
4.4.1 Connecting the personal computer and PLC CPU

Step 2 Select [Diagnostics] → [GOT Diagnostics] from the menu to display the [Communication Configuration] 
dialog.

➟4.8.8 [Communication Configuration] dialog
If the [GOT Diagnostics] dialog appears, any of the following settings is configured.
(Proceed to step 4.)

• On the [Operation] tab in the [Options] dialog, [Display the dialog of Communication Setting before 
displaying the dialog of Communicate with GOT/GOT Diagnostics] is cleared.

• In the [Communication Configuration] dialog, [Display the dialog of [Communication Configuration] the 
next time as well] is cleared.

Step 3 Configure the setting according to the communication path between the GOT and the personal computer, 
and click the [OK] button to display the [GOT Diagnostics] dialog.

➟11.14.5 [GOT Diagnostics] dialog
Step 4 Click the [Start Monitoring] button to obtain system status log data from the GOT and list the recorded errors 

in the error list.

Step 5 Click an error in the error list to display its causes and corrective actions.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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If an error with supplementary information is selected, click the [Related information] button to display a 
relevant page of GT Designer3 Help.

■2 Saving the contents of the error list to a file
The following shows the procedure for saving the contents of the error list displayed in the [GOT Diagnostics] dialog to a 
CSV or Unicode text file.

Step 1 In the [GOT Diagnostics] dialog, obtain system status log data from the GOT.

➟11.14.2 ■1 Obtaining system status log data from the GOT and displaying error information
Step 2 Set the items as shown below.

• [Refinement]: Type of errors to be displayed in the error list
• [Series Display Selection]: This item appears when a system alarm (CPU error) of MITSUBISHI 

equipment is selected in the error list.
Select the controller series to which the display contents of [Overview], [Cause], and [Corrective Action] 
for the system alarm (CPU error) correspond.
Click the [Start Monitoring] button to automatically identify the series of the controller in which a selected 
error occurred.

➟11.14.5 [GOT Diagnostics] dialog
Only the contents narrowed by the above items are output to a file.

Step 3 Click the [Create File] button to display the [Save As] dialog.
Step 4 Set [File name] and [Save as type], and click the [Save] button to save the contents of the error list.

For the format of the saved file, refer to the following.
➟11.14.1 ■3 Format of a saved file
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11.14.3 GOT internal device monitor

On GT Designer3, you can monitor the GOT internal devices and change the device values as necessary.
You can import the sample free registration lists of the GOT internal devices related to specific functions.

■1 Specifications of the GOT internal device monitor
(1) Devices that can be monitored

You can monitor the GOT internal devices (GB, GD, and GS) and change their current values.
➟12.1 GOT Internal Device

However, the current values of the following devices are not changeable.
• GB0 to GB63 (GB0 to GB38 and GB40 to GB63 for GT21 and GS21)
• Write devices of the GOT special registers (GS)

(2) Specifications of the free registration list
Use a free registration list to manage the GOT internal devices to be monitored.
A created free registration list is retained after GT Designer3 exits.
Up to 32 free registration lists can be created.
Up to 32 characters are available for a free registration list name.
The following characters cannot be used in a free registration list name.
\ / : ; * ? " < > | .
Up to 6 free registration windows can be open simultaneously.
Up to 256 devices are registrable in one free registration list.

(3) Importing or exporting a free registration list
You can import or export a free registration list.
The CSV format and the Unicode text format are supported.

An exported free registration list is editable with spreadsheet software or others.
The following shows the layout of an exported free registration list.

1) Version
Version of the free registration list.

2) List type
Type of a list.
Fixed to 0.

3) List name
Name of the free registration list.
For the name specifications, refer to the following.

➟(2) Specifications of the free registration list
4) Number of devices

Number of the registered devices.
Up to 256 devices are registrable in one free registration list.

5) No.
Registered device number.

6) Device
Registered device.

7) Data type
Data type of a device

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• BIT: [Bit]
• BIN8: [Byte [Signed]]
• BIN8_Unsigned: [Byte [Unsigned]/Bit String [8-bit]]
• BIN16: [Word [Signed]]
• BIN16_Unsigned: [Word [Unsigned]/Bit String [16-bit]]
• BIN32: [Double Word [Signed]]
• BIN32_Unsigned: [Double Word [Unsigned]/Bit String [32-bit]]
• BIN64: [Quad Word [Signed]]
• BIN64_Unsigned: [Quad Word [Unsigned]/Bit String[64-bit]]

8) Display format
Display format of a device.

• BIN: [Binary]
• OCT: [Octal]
• DEC: [Decimal]
• HEX: [Hexadecimal]

9) Comment
Comment set for a device.
Up to 255 characters can be set for one comment.

(4) Sample free registration lists
You can import the sample free registration lists of the GOT internal devices related to the following functions.

The sample free registration lists are stored in the following directory when GT Designer3 is installed.
[(Path to the installation location of GT Designer3)\GTD3_2000\App\SampleDevMonitor]
The sample lists for the project script, screen script, object script and GOT operational authority are imported 
automatically at the initial startup of the GOT internal device monitor.

Function File name of a sample list

Project script, screen script 1_Project_ScreenScript.txt

Object script 2_ObjectScript.txt

GOT operational authority 3_GOT_OperationalAuthority.txt

Server function 4_ServerFunction.txt

Client function 5_ClientFunction.txt

Device data transfer 6_DeviceDataTransfer.txt

File transfer function 7_FileTransfer.txt

Mail send function 8_MailFunction.txt

Recipe 9_Recipe.txt

Global label 10_Label.txt

VNC server function 11_VNC_Server.txt
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■2 How to use the GOT internal device monitor
(1) Monitoring GOT internal devices

The following shows the procedure for monitoring GOT internal devices.
Step 1 Configure the settings to enable the GOT internal device monitor.

In the [GOT Setup] window ([GOT Internal Device Monitor]), select the following items.
• [Update the GOT internal device monitor setting]
• [Use GOT internal device monitor in the GOT diagnostics function]

To change the values of GOT internal devices by using the GOT internal device monitor, select [Allow GOT 
internal devices to be changed].

➟5.3.7 Configuring the settings of the GOT internal device monitor ([GOT Internal Device Monitor])
Step 2 Write package data to the GOT.

For the communication method between the personal computer (GT Designer3) and the GOT, refer to the 
following.

➟4. COMMUNICATING WITH GOT
Step 3 In the [GOT Diagnostics] dialog, start the GOT internal device monitor.

➟11.14.5 [GOT Diagnostics] dialog
11.14.6 [GOT Internal Device Monitor] window

The starting method varies according to the status of the GOT diagnostics.
• While the GOT diagnostics is running

Click the [GOT Internal Device Monitor] button to display the [GOT Internal Device Monitor] window.
• While the GOT diagnostics is not running

Click the [GOT Internal Device Monitor] button to display the [GOT Internal Device Monitor] window, and 
perform one of the following operations.
· Select [Online] → [Start] from the menu.
· Click the [Start] button on the toolbar.
· Click the [Start Monitoring] button in the [GOT Diagnostics] dialog.

Step 4 Register the target GOT internal devices in a free registration list.
Monitoring starts upon the registration of the devices.

Step 5 To change the current value of a GOT internal device, enter a new value in [Current Value].
The GOT internal device stores the new value upon the entering of the value.

(2) Creating or editing a free registration list
Register a GOT internal device in a free registration list to monitor or change the current value of the device.
The following shows the procedure for creating or editing a free registration list.

Step 1 Perform one of the following operations to display a free registration window.
• Select [Window] → [New Free Registration List] from the menu.
• Double-click [New] under [Free Reg] in the [Project] window.
• Double-click a target free registration list under [Free Reg] in the [Project] window.

For information on how to import a free registration list and add it as a new list, refer to the following.
➟(3) Importing a free registration list

Step 2 Register, edit or delete a GOT internal device in the free registration window.

➟11.14.6 [GOT Internal Device Monitor] window
To rename a free registration list, select a target free registration list, and click it again or press the [F2] key on the 
keyboard.
To delete a device in a free registration list, select a target device, and press the [Delete] key on the keyboard.

(3) Importing a free registration list
Import a free registration list file in the CSV or Unicode text format.
The following shows the procedure for importing a free registration list.

Step 1 Perform one of the following operations in the [Project] window according to the import method.
• To import a free registration list and add it as a new list, select [New].
• To overwrite an existing free registration list with an imported list, select the target existing free 

registration list.
• To import multiple free registration lists, select [Free Reg] at the top of the tree.

Step 2 Perform one of the following operations to display the [Open] dialog.
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• Select [File] → [Import Free Registration List] from the menu.
• In the [Project] window, click the [Im] button.
• Right-click the item selected in step 1, and select [Import] from the menu.

Step 3 Select a free registration list file and click the [Open] button to import the file.
When importing multiple files, you can import CSV files and Unicode text files together.
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
12.9 Precautions for Using Unicode Text File

(4) Exporting one free registration list
The following shows the procedure for exporting one free registration list to a CSV or Unicode text file.

Step 1 In the [Project] window, select one free registration list to be exported.
Step 2 Perform one of the following operations to display the [Save As] dialog.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click the free registration list to be exported, and select [Export] from the menu.

Step 3 Set [File name] and [Save as type], and click the [Save] button to export the free registration list.

(5) Exporting all free registration lists
The following shows the procedure for exporting all free registration lists to CSV or Unicode text files.

Step 1 In the [Project] window, select [Free Reg] at the top of the tree.
Step 2 Perform one of the following operations to display a dialog where you can select a file format.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click [Free Reg] at the top of the tree, and select [Export] from the menu.

Step 3 Select a file format and click the [OK] button to display the [Browse For Folder] dialog.
Step 4 Select an export destination and click the [OK] button to export the free registration lists.

(6) Deleting a free registration list
The following shows the procedure for deleting a free registration list.

Step 1 In the [Project] window, select a free registration list to be deleted.
Step 2 Perform one of the following operations to display a confirmation dialog.

• Press the [Delete] key on the keyboard.
• Right-click the free registration list to be deleted, and select [Delete] from the menu.

Step 3 Click the [Yes] button to delete the list.
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11.14.4 Precautions

■1 Power saving function of the personal computer
Before performing the GOT diagnostics, disable the power saving function of the personal computer and Windows.
For the details of the power saving function setting, refer to the manual of the personal computer or Windows Help.

■2 GOT diagnostics while firmware update is in progress
The GOT diagnostics cannot start while firmware update of the communication unit mounted on the GOT is in progress.
To perform the GOT diagnostics, make sure that the firmware update is not in progress.

■3 Performing the GOT diagnostics while the FA transparent function is used
While the controller programming software communicates with a controller by using the FA transparent function, the GOT 
diagnostics cannot start.
To perform the GOT diagnostics, make sure that the FA transparent function is not in use.

■4 System alarms (CPU errors and network errors) displayed in the GOT diagnostics and the 
controller status

In the GOT diagnostics, system alarms (CPU errors and network errors) are displayed based on the error history recorded 
in the GOT (System status log). Therefore, the alarms does not indicate the controller status.
To check the controller status, use one of the following methods.
• Using a diagnostics function of the controller programming software

➟Manual for the programming software used
• Checking system alarms in the GOT utility

➟GOT2000 Series User's Manual (Utility)

■5 Resetting script error data
You cannot reset scrip error data in the following cases.
• The GOT displays a screen in which no script is set.
• The GOT displays the utility screen.
Reset scrip error data while the GOT displays a screen in which a script is set.

■6 Changing the values of GOT internal devices
With the GOT internal device monitor, the values of GOT internal devices are changeable from GT Designer3. In such a 
case, the GOT may not behave as its operator expects.
To disable the changing of the device values from GT Designer3, deselect [Allow GOT internal devices to be changed] 
in the [GOT Setup] window ([GOT Internal Device Monitor]).

■7 Precautions for exporting a free registration list
When a free registration list contains characters that cannot be represented in ASCII or Shift JIS code, export the list to 
a Unicode text file.
If you export the list to a CSV file, such characters are not output properly.
For the precautions for using Unicode text files, refer to the following.

➟12.9 Precautions for Using Unicode Text File

■8 Precautions for using the CC-Link IE TSN connection
When a controller is monitored using the CC-Link IE TSN connection, system alarms (CPU errors) are not displayed.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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11.14.5 [GOT Diagnostics] dialog

In this dialog, system status log data is obtained from the GOT and error information is listed.
To display the dialog, select [Diagnostics] → [GOT Diagnostics] from the menu.

1) Connected GOT
Type and name of the connected GOT

2) [GOT Internal Device Monitor] button
Displays the [GOT Internal Device Monitor] window.

➟11.14.6 [GOT Internal Device Monitor] window
3) [Start Monitoring] button, [Stop Monitoring] button

Starts or stops the GOT diagnostics.
4) [Communication Path]

Communication path between the personal computer and the GOT
5) [Communication Configuration] button

Displays the [Communication Configuration] dialog.
Set the communication path between the personal computer and the GOT.

➟4.8.8 [Communication Configuration] dialog
6) [Refinement]

Select the category of errors to be displayed in the error list.
The following shows selectable items.

• [All]
• [GOT Error]
• [CPU Error]
• [Network Error]
• [Script Error]

7) Error list
Lists errors based on the system status data recorded in the GOT.
Errors are displayed in reverse chronological order. If the number of errors exceeds the maximum number of displayed 
errors, earlier errors are not displayed.
The latest errors in each category are indicated with [New] in the [No.] column.
The maximum number of displayed errors depends on the error type.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• System alarm (GOT error): 30
• System alarm (CPU error or network error): 30
• Script error (Project script or screen script): 15
• Object script error: 15

For the system alarm (GOT error), script error, and object script error, correct an error and click the [Reset] button to 
delete the error from the error list.
For the precautions on the system alarm, refer to the following.

➟9.1.3 ■4 (4) Display of system alarms occurring in multiple channels
8) [Reset] button

Resets error data in the GOT, and updates the error list.
Corrected system alarms (GOT errors) and script errors are deleted from the error list.
Others remain in the list.
For the precautions on the script error or object script error, refer to the following.

➟9.9.12 ■1 (11) Script error control and GOT status
　 9.10.7 ■1 (10) Object script error control and GOT status

9) [Cause]
Causes of an error selected in the error list

10) [Corrective Action]
Corrective actions to correct an error selected in the error list

11) [Series Display Selection]
This item appears when a system alarm (CPU error) of MITSUBISHI equipment is selected in the error list.
Select the controller series to which the display contents of [Overview], [Cause], and [Corrective Action] for the system 
alarm (CPU error) correspond.
Upon updating the error list, selecting a relevant error automatically identifies the series of the controller in which the 
error occurred.
The following shows selectable items.

• [MELSEC iQ-R Series]
• [MELSEC iQ-F Series]
• [MELSEC-Q Series Basic Model]
• [MELSEC-Q Series High-performance Model]
• [MELSEC-Q Series Universal Model]
• [MELSEC-L Series]
• [MELSEC-L Series Head Module]
• [MELIPC]

12) [Related information] button
Displays GT Designer3 Help, showing a relevant page for an error selected in the error list.
This item appears when an error with supplementary information is selected in the error list.

13) [Create File] button
Saves the contents of the error list to a CSV or Unicode text file.

➟11.14.1 ■3 Format of a saved file
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11.14.6 [GOT Internal Device Monitor] window

In this window, monitor the GOT internal devices, and change the device values as necessary.
To display the window, click the [GOT Internal Device Monitor] button in the [GOT Diagnostics] window.

1) Title bar
Displays the operation status of the GOT internal device monitor.

2) Menu bar
Displays the operation menus of the GOT internal device monitor.

➟■1 Menus
3) Toolbar

Displays the operation buttons of the GOT internal device monitor.
➟■2 Toolbar

4) [Project] window

5) Work window
An area in which free registration windows appear.

➟■3 Free registration window
6) Editor tab

Displays the tabs corresponding to the windows opened in the work window.

• Expand all button, collapse all button
Expands or collapses all items in the tree.

• [Im] button
Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the 
following.
➟11.14.3 ■2 (3) Importing a free registration list

• [Ex] button
Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the 
following.
➟11.14.3 ■2 (4) Exporting one free registration list
11.14.3 ■2 (5) Exporting all free registration lists

• [Free Reg]
Displays created free registration list names.

• [New]
Creates a free registration list.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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To bring an open window to the foreground in the work window, select its tab.

7) Status bar
Displays the description of a selected menu.

■1 Menus
(1) [File]

(2) [View]

(3) [Online]

(4) [Window]

(5) [Help]

• Pull-down menu button
Lists the open windows in the work window.
To bring an open window to the foreground in the work window, 
select it from the pull-down menu.

Pull-down menu button

Menu Description

[Import Free Registration List]
Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the following.

➟11.14.3 ■2 (3) Importing a free registration list

[Export Free Registration List]

Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the following.

➟11.14.3 ■2 (4) Exporting one free registration list
11.14.3 ■2 (5) Exporting all free registration lists

[Exit] Ends the device monitor.

Menu Description

[Toolbar] Displays or hides the toolbar.

[Status Bar] Displays or hides the status bar.

Menu Description

[Start] Starts monitoring the GOT internal devices.

[Stop] Stops monitoring the GOT internal devices.

Menu Description

[New Free Registration List] Create a free registration list.

[Cascade] Displays open windows in a stack in the work window.

[Arrange Sideways] Tiles open windows side by side in the work window.

[Arrange Lengthways] Tiles open windows horizontally in the work window.

[Close Inactive Windows] Closes all open windows except the selected one in the work window.

[New Horizontal Tab Group]

Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in a pane immediately 
underneath the current pane.
Tabs are movable between the editor tabs of panes.

[New Vertical Tab Group]

Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in the immediately right 
pane.
Tabs are movable between the editor tabs of panes.

Menu Description

[GT Designer3 Help] Displays GT Designer3 Help.
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■2 Toolbar

1) [Start]
Starts the device monitor.

2) [Stop]
Stops the device monitor.

3) [Cascade]
Displays open windows in a stack in the work window.

4) [Arrange Sideways]
Tiles open windows side by side in the work window.

5) [Arrange Lengthways]
Tiles open windows horizontally in the work window.

6) [Close Inactive Windows]
Closes all open windows except the selected one in the work window.

7) [New Horizontal Tab Group]
Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in a pane immediately underneath the current 
pane.
Tabs are movable between the editor tabs of panes.

8) [New Vertical Tab Group]
Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in the  immediately right pane.
Tabs are movable between the editor tabs of panes.

9) [GT Designer3 Help]
Displays GT Designer3 Help.

1) 3) 5) 7) 9)
2) 4) 6) 8)
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■3 Free registration window

1) [Device]
Set a GOT internal device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of a GOT internal device.
The following shows selectable items.

• [Bit]
• [Byte [Unsigned]/Bit String [8-bit]]
• [Word [Unsigned]/Bit String [16-bit]]
• [Double Word [Unsigned]/Bit String [32-bit]]
• [Quad Word [Unsigned]/Bit String[64-bit]]
• [Byte [Signed]]
• [Word [Signed]]
• [Double Word [Signed]]
• [Quad Word [Signed]]

3) [Current Value]
Displays the current value of a GOT internal device.
The set value is changeable.
The setting range of [Current Value] depends on the device.
If a communication error occurs, [--] is displayed.
When any of the following is selected for [Data Type], displaying or changing the current value is not available.

• [Byte [Unsigned]/Bit String [8-bit]]
• [Quad Word [Unsigned]/Bit String[64-bit]]
• [Byte [Signed]]
• [Quad Word [Signed]]

4) [Display Format]
Select the display format of a GOT internal device.
The following shows selectable items.

• [Binary]
• [Octal]
• [Decimal]
• [Hexadecimal]

5) [Comment]
Set a comment for a GOT internal device.
Up to 255 characters can be set for one comment.

1) 2) 3) 4) 5)
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11.15 Offline Reproduction and Monitoring of Operation (GOT Offline 
Monitor)

The GOT offline monitor function is used to reproduce the circumstances of the troubled site by establishing connection 
with the GX Works3 offline monitor on a personal computer.
Using the file that records the circumstances when the trouble occurred and the project of that time, you can grasp the 
circumstances which enables a cause investigation.

➟11.15.1 Specifications of the GOT offline monitor
11.15.2 How to use the GOT offline monitor
11.15.3 Precautions for the GOT offline monitor
11.15.4 Screen layout of the GOT offline monitor
11.15.5 [Setting] dialog (GOT offline monitor)
11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
11.15.7 How to use a Resource File Viewer module
11.15.8 Screen layout of a Resource File Viewer module

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Line
A 1254

B 348
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GOTPLC

GX Works3 offline monitor GOT offline monitor

Recording file Project Resource file

Monitoring a recording file Monitoring a project

Resource file viewer

Monitoring a resource file
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11.15.1 Specifications of the GOT offline monitor

■1 Operating environment of the GOT offline monitor
The following shows the operating environment for the GOT offline monitor.

■2 Monitoring-supported GOTs
The following shows the monitoring-supported GOTs with the GOT offline monitor.

*1 The following items are displayed in 16777216 colors.
• Parts display
• Parts movement
• Image file

*2 Capacity of the GOT user area where package data is stored.

■3 Number of GX Works3 offline monitors that can be monitored
One GX Works3 offline monitor can be monitored.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

Model Windows-compatible personal computer

OS (English, Simplified 
Chinese, Traditional Chinese, 
Korean, German, or Italian 
version)

• Microsoft Windows Server 2016 Standard (64 bit)
• Microsoft Windows Server 2012 R2 Standard (64 bit)
• Microsoft Windows Server 2008 R2 Enterprise (64 bit)
• Microsoft Windows Server 2008 R2 Standard (64 bit)
• Microsoft Windows 11 Education (64 bit)
• Microsoft Windows 11 Enterprise (64 bit)
• Microsoft Windows 11 Pro (64 bit)
• Microsoft Windows 11 Home (64 bit)
• Microsoft Windows 10 Enterprise (32 bit, 64 bit)
• Microsoft Windows 10 Pro (32 bit, 64 bit)
• Microsoft Windows 10 Home (32 bit, 64 bit)
• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 bit) (English OPK, or English OPK with a language pack for localization)

CPU Use the CPU which the above OSs run on.

Memory Use the CPU which the above OSs run on.

Display Use the CPU which the above OSs run on.

Hard disk space Use the CPU which the above OSs run on.

Other software
• GX Works3 Version1.065T or later
• When using Resource File Viewer: Microsoft .NET Framework 4.5.2 or later

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD drive
• For execution: Mouse and keyboard
• For sound output (such as buzzer): Sound card, speaker

Name Resolution (dot) Display color *1 Memory capacity *2

GT27**-X 1024 × 768 65536 colors 57 MB

GT27**-S 800 × 600 65536 colors 57 MB

GT27**-V 640 × 480 65536 colors 57 MB

GT2705-V 640 × 480 65536 colors 32 MB

GT25**-WX 1280 × 800 65536 colors 32 MB

GT25**-W 800 × 480 65536 colors 32 MB

GT25**-S 800 × 600 65536 colors 32 MB

GT25**-V 640 × 480 65536 colors 32 MB

GT2505-V 640 × 480 65536 colors 32 MB

GT23**-V 640 × 480 256 colors 9 MB

GT SoftGOT2000 640 × 480 to 1920 × 1200 65536 colors 57 MB

GS25**-WX 1280 × 800 65536 colors 32 MB
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■4 Software version of GX Works3
Use GX Works3 version 1.065T or later.

■5 Monitoring-supported controllers
When connected with the GX Works3 offline monitor, the GOT offline monitor can monitor the following virtual controllers.

■6 Monitoring-supported devices
(1) Read only devices

The devices that satisfy all of the following requirements can be read.
Writing is not available.

(2) Readable/writable devices
The following shows the readable/writable devices.

• GOT internal devices
• SoftGOT2000 internal devices

■7 Monitoring-supported functions
(1) Common functions

○: Supported, ×: Unsupported

Controller model Firmware version

R04CPU
R08CPU
R16CPU
R32CPU
R120CPU
R04ENCPU
R08ENCPU
R16ENCPU
R32ENCPU
R120ENCPU

Version 48 or later

R08SFCPU
R16SFCPU
R32SFCPU
R120SFCPU

Version 21 or later

Requirement Reference

Devices that can be monitored by GX Works3 ➟GX Works3 Operating Manual

Devices that can be monitored by the GOT
(Except the timer set value (TS) and counter set value (CS) of 
the Mitsubishi Electric PLC)

➟12.3 Device Range and Settings of Mitsubishi Electric 
Equipment

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

System font display ○ Multi-channel connection ×

Option font display ○ Vertical display ○

Superimposition of objects ○ Touch panel and touch key ○

Base screen display ○ Numerical display/input ○

Overlap window display ○ Text display/input ○

Superimpose window display ○*1 Historical data list display ×

Key window display ○ Clock display ○

Set overlay screen ○ Comment display ○

Screen switching ○*2 Alarm display ×

Station No. switching ○ Alarm popup display ×

Buffer memory unit No. switching ○ Recipe display (record list) ○

Language switching ○*3 Graphical meter ○

System information ○ Panelmeter ○

Security authentication ○*4 Historical trend graph ×
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*1 The touch operation is not disabled even though [Disable the touch operation of a screen on the back] is selected in the 
detail setting for the overlap window.

➟5.2.1 ■2 (8) Disabling the touch operation on the screens that are behind an overlap window
*2 Use a Go To Screen switch or configure the screen switching setting for the GOT offline monitor.

➟11.15.2 ■4 Switching the screen to be monitored
*3 Configure the language switching setting for the GOT offline monitor.

➟11.15.2 ■5 Switching the display language
*4 Configure the security authentication setting for the GOT offline monitor.

➟11.15.2 ■6 Switching the security level
*5 Only available for file output.
*6 The GOT internal devices (GB, GD, GS) and SoftGOT2000 internal devices (SGB, SGD) can be used.

Note that among the GOT internal devices, GS500 to GS507 supported only by GT SoftGOT2000 cannot be used.
*7 The GOT internal devices (GB, GD, GS) and script parts temporary device areas (PTMP) can be used.

(2) Utility function

○: Supported, ×: Unsupported

Trigger action ○ Line graph ○

Time action × Bar graph ○

Hard copy function ○*5 Scatter graph ○

Comment ○ Statistics graph ○

Figure ○ Level display ○

Internal device ○*6 Touch switch ○

Cursor movement ○ Slider ○

Operation log × Video/RGB display object ×

Logging × Script parts ○*7

Recipe ○ Mobile screen display ×

Script ○ Hyperlink ×

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

[GOT basic set]

[Display] ○ [Time] ×

[Language] ○ [Controller] ×

[Specific Information] × [Ethernet Communication] ×

[IP Address] × [Transparent Mode] ×

[IP filter setting] × [GOT Internal Device Monitor] ×

[Operation] ○ [Security] ○

[Utility Call Key] ○ [Operator Authentication] ×

[USB Host] ×

[Ext. func. Set]

[SoftGOT-GOT Link Function] × [Wireless LAN Setting] ×

[VNC Server Function] × [System launcher] ×

[Sequence Program Monitor] × [iQSS utility] ×

[Backup Restoration] × [ANDON Setting] ×

[License Management] × [Ethernet printer] ×

[Video/RGB] × [Network Drive] ×

[Multimedia] ×
11. USEFUL FUNCTIONS
11.15 Offline Reproduction and Monitoring of Operation (GOT Offline Monitor)

11 - 227



*1 [Delete all labels] and [Sort out labels] are supported.
*2 [Initialize all] and [Initialize selected area] are supported.
*3 Only [Preview] is supported.

(3) Extended function

○: Supported, ×: Unsupported

[Maintenance]

[Batch Self Check] × [Font check] ×

[USB Device Management] × [Touch panel check] ×

[Clean/Display Screen] × [I/O check] ×

[Touch panel calibration] × [Ethernet Status Check] ×

[System Alarm] × [GOT Information] ×

[Drawing check] × [GOT Mobile information] ×

[Monitor]

[System launcher] × [Q Motion SFC monitor] ×

[Device monitor] × [Log viewer] ×

[Seq. program monitor(Ladder)] × [Network status display] ×

[Seq. program mon.(iQ-R Ladder)] × [FX list editor] ×

[FX Ladder monitor] × [CNC Machining Program Edit] ×

[Network monitor] × [CNC data I/O] ×

[Intelligent module monitor] × [Motion program editor] ×

[Servo amp Monitor] × [Motion program I/O] ×

[Q Motion monitor] × [MELSEC-L Troubleshooting] ×

[R Motion monitor] × [iQSS utility] ×

[CNC monitor] × [Drive recorder] ×

[CNC monitor2] × [CC-Link IE diagnostics] ×

[Seq. program monitor(SFC)] × [Servo amplifier graph] ×

[R Motion SFC monitor] × [Vision sensor monitor] ×

[Data mng.]

[Alarm information] × [Package Management] ○*1

[Image File Management] ○ [Backup Restoration] ×

[Recipe Information] ○ [SRAM control] ○*2

[Logging information] × [Memory card format] ×

[Operation log information] × [Memory check] ×

[File manager] × [GOT Pkg. acquisition] ×

[File print] ○*3

Category Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed

Screen gesture × Device monitor ×

Object gesture × Network monitor ×

Kana-Kanji/Pinyin conversion ○ Log viewer ×

Wireless LAN × iQSS utility ×

SoftGOT-GOT link function × Intelligent module monitor ×

System launcher × Servo amplifier monitor ×

Sequence program monitor (Ladder) × Drive recorder ×

Sequence program monitor (SFC) × R motion monitor ×

FX ladder monitor × Q motion monitor ×

Backup/restore × CNC monitor ×

Gateway (Server, Client) × CNC data I/O ×

Gateway (Mail) × CNC machining program edit ×
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*1 Only [Preview] is supported.
*2 In the simulation, files can be saved into virtual drives only.

■8 Destination to save data
Folders in the hard disk of the personal computer are handled by the GOT offline monitor as the virtual drive.

Gateway (FTP server) × CNC monitor 2 ×

File transfer function × Motion program editor ×

Barcode × Motion program I/O ×

RFID × R motion SFC monitor ×

Remote personal computer operation (Serial) × Q motion SFC monitor ×

Remote personal computer operation (Ethernet) × FX list editor ×

VNC server × Vision sensor monitor ×

Video display × CC-Link IE TSN/CC-Link IE Field Network 
diagnostics ×

RGB display × Recipe operation ○

Multimedia × Recipe display (record list) ○

Operation panel × Operation log screen image ×

External I/O × Operator authentication ○

Report ○ File manager ×

Printer × File print ○*1

Sound output ○ Document display ○

GOT network interaction × MELSEC-L troubleshooting ×

GOT Mobile Setting × Video/RGB display object ×

Device data transfer ○ GOT Platform Library ×

Servo amplifier graph × Network drive ○*2

MES interface × Base screen size expansion ○

Function
Supported/
Unsupport

ed
Function

Supported/
Unsupport

ed
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(1) For functions saving data into a data storage or file server
When a data storage or file server is specified to save the files for functions including object functions and extended 
functions, data is saved onto the hard drive of the personal computer.
The files for each function are saved into the folders as shown below.

The drive unavailable to the monitoring target GOT is not usable.
*1 For the working folder, refer to the following.

➟(3) Working folder
*2 In the simulation, files can be saved into virtual drives only.
*3 For details on drive V, refer to the following.

➟11.15.3 ■10 Virtual drive V

(2) For functions requiring the user to save data into a data storage
When registering BMP, JPEG, or PNG files used as parts, or data for document display, save them in the hard disk of 
the personal computer.
Store each data in the following (user-created) folders.
(The drive to be used depends on the specifications of the object or setting.)

*1 For the working folder, refer to the following.

➟(3) Working folder
*2 In the simulation, files can be saved into virtual drives only.

(Working folder)

GOTOM

Drive

A

Folder name set in GT Designer3

G2GssUsr

Regardless of the folder name or file name set in GT Designer3, 
the file shown on the left is stored in the [G2GssUsr] folder.

Folder storing files for each function

Print image of the hard copy
   HARDCOPY.BMP

B, E, F, G

A folder is created for each drive.

Folder name set in GT Designer3 Folder storing files for each function

Standard SD card

USB drive

*1

Print image of the report
   REP*****.CSV
   [*****] indicates the screen number.

N

Folder name set in GT Designer3 Folder storing files for each function *²

Network drive

V Built-in RAM *³

Drive

A

PDFDAT
Docimg

(Working folder)

B

GOTOM

*1

Image *2

Stores the JPEG files for the document display.

Stores BMP or JPEG files.
Stores the PDF files for the document display.
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(3) Working folder
The following shows a working folder.
Users\(user name)\AppData\Local\MITSUBISHI\GSS3

11.15.2 How to use the GOT offline monitor

■1 Starting the GOT offline monitor
To start the GOT offline monitor, establish connection between the GX Works3 offline monitor and the GOT offline 
monitor.
Start the GOT offline monitor in GT Designer3 or GX Works3.

(1) In GT Designer3
Step 1 Start the GX Works3 offline monitor.

➟GX Works3 Operating Manual
Step 2 Start GT Designer3 and open the project to be monitored in the GOT offline monitor.

➟2.3.2 Opening a project
Step 3 In GT Designer3, start the GOT offline monitor by either of the following methods.

• Select [Tools] → [GOT Offline Monitor] → [Activate] from the menu.
• Click the [GOT Offline Monitor: Activate] button on the toolbar.

Step 4 Specify the recording file read from the GX Works3 offline monitor at the first startup.
When the [Recording File Setting] dialog is displayed, select the recording file to be monitored and click the 
[OK] button to start monitoring.
After the first startup, the recording file read at the last startup is read and monitoring starts.
For details on a recording file, refer to the following.

➟GX Works3 Operating Manual

(2) In GX Works3
Step 1 Start the GX Works3 offline monitor.

➟GX Works3 Operating Manual
Step 2 When the GOT offline monitor is started in GX Workd3 , the [Open Project] dialog is displayed.

➟GX Works3 Operating Manual
Step 3 Select a GT Designer3 project to be monitored in the GOT offline monitor, and click the [Open] button to 

start monitoring.

■2 Ending the GOT offline monitor
When the GOT offline monitor is ended, the GX Works3 offline monitor is disconnected.
You can end the GOT offline monitor in GT Designer3, the GOT offline monitor, or GX Works3.

(1) In GT Designer3
End the GOT offline monitor by either of the following methods.

• Select [Tools] → [GOT Offline Monitor] → [Exit] from the menu.
• Click the [GOT Offline Monitor: Exit] button on the toolbar.

(2) In the GOT offline monitor
End the GOT offline monitor by either of the following methods.

• Select [Project] → [Exit] from the menu.
• Select [Online] → [Monitor Stop] from the menu.
• Click the [×] button.

(3) In GX Works3
You can end the GOT offline monitor in GX Works3 only when the GOT offline monitor is started in GX Works3.
For the details, refer to the following.

➟GX Works3 Operating Manual

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(4) At disconnection of the GX Works3 offline monitor
When [Terminate GOT Offline Monitor when disconnected from GX Works3 Offline Monitor] is selected in the [Auxiliary 
Setup] tab in the [Setting] dialog, the GOT offline monitor automatically ends at disconnection of the GX Works3 offline 
monitor.

➟11.15.5 ■3 [Auxiliary Setup] tab

■3 Changing the option settings of the GOT offline monitor
Change the option settings of the GOT offline monitor in the [Setting] dialog.

➟11.15.5 [Setting] dialog (GOT offline monitor)

■4 Switching the screen to be monitored
Switch the currently monitored screen in the project by either of the following methods.

• Use the pull-down menu on the toolbar or arrow buttons.
➟11.15.4 ■2 Toolbar

• Use a Go To Screen switch.
Switching by using a device is not available.

➟8.2.7 [Go To Screen Switch] dialog
For details on the screen switching, refer to the following.

➟5.2.1 Setting for switching screens to be displayed on the GOT ([Screen Switching/Window])

■5 Switching the display language
The GOT switches comments displayed on the object by changing the value (column number of the comment group) 
using the pull-down menu on the toolbar.
If messages are registered by language in each column of the comment group, the language of the comment displayed 
can be switched.

➟11.15.4 ■2 Toolbar
For details on the language switching, refer to the following.

➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

■6 Switching the security level
Switch the security level of the project currently monitored using the pull-down menu on the toolbar.

➟11.15.4 ■2 Toolbar
For details on the screen security, refer to the following.

➟5.2.6 Configuring the security settings for the GOT screen ([Screen Security])

■7 Using Resource File Viewer
Displays the resource files read from the GOT.
For details on Resource File Viewer, refer to the following.

➟11.15.7 How to use a Resource File Viewer module
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■8 Capturing snap shots
Save the image of a monitor screen as a BMP format file or a JPEG format file.

Step 1 Select [Project] → [Snap Shot] from the menu.
Step 2 The [Save As] dialog appears.

Configure the following settings and click the [Save] button.

1) [Save in]
Select a location for saving a file.

2) [File Name]
Name the screen image file to be saved.

3) [Save as type]
Select the BMP format or the JPEG format.

■9 Printing a monitor screen
Output the image of a monitor screen to a printer.

➟(1) Printing
(2) Previewing the print image
(3) Page setting
(4) Configuring the printer setting

(1) Printing
Step 1 Select [Project] → [Print] from the menu.
Step 2 The [Print] dialog of Windows is displayed.

Click the [OK] button to start printing.

1)

3)
2)
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(2) Previewing the print image
Step 1 Select [Project] → [Print Preview] from the menu.
Step 2 The print preview is displayed.

Precautions for using the print preview
The print preview of a monitor screen may look smaller than the actual screen depending on the paper type or 
size, and the screen resolution.
Therefore, printed material may look different from the print preview in color.
Check the printed material.
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(3) Page setting
Step 1 Select [Project] → [Page Setup] from the menu.
Step 2 The [Page Setup] dialog is displayed.

Configure the following settings and click the [OK] button.

1) [Margin]
Set margins for the page to be printed.

2) [Reverse screen image]
Select this item to reverse colors of the screen image at printing.

3) [Reverse Mode]
Set a reverse method for the screen image.
The following shows selectable items.

• [Color]: Reverses whole colors of the screen image to be printed.
• [Black and White]: Reverses white to black of the screen image to be printed.

(4) Configuring the printer setting
Step 1 Select [Project] → [Print Setup] from the menu.
Step 2 The Windows print dialog box is displayed.

Configure the settings for the printer (selecting a printer, paper size, direction of printing).

(1) Precautions for the printer used
Each GOT model that performs monitoring has its own print settings.
However, when you perform one of the following operations, the printer selected for [Set as default printer] 
in Windows is specified.

• Deleting the selected printer
• Selecting a printer whose name contains 31 characters or more

(2) Precautions for the print settings
Depending on the printer used, some print settings are not retained.

■10 Displaying the information of the currently monitored project
The project title, project ID, and the data size of the currently monitored project data are displayed.

Step 1 Select [Project] → [Properties] from the menu.
Step 2 The [Properties] dialog appears.

1) [Project Title]
Displays the title for the project.

2) [Project ID]
Displays the project ID.

3) [Data Size]
Displays the data size of the project data.

1)

3)
2)

1)

3)
2)
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When the properties dialog box is displayed before starting monitoring
When the [Properties] dialog is displayed before starting monitoring, the project title, the project ID, and the data 
size of the previous monitoring are displayed.
When the project data is not read, the project title, the project ID, and the data size are not displayed.

■11 Operating the numerical input or text input with a keyboard
Operate the numerical input or text input with the keyboard of a personal computer.

Perform one of the following operations to enable or disable the keyboard input.
• Select [Set] → [Keyboard] from the menu.
• Click the [Keyboard] button on the toolbar.
• Select [Set] → [Keyboard] from the right-click context menu.

The following shows how to operate the numerical input or text input with a keyboard.

*1 The operation on the target object varies depending on the setting in the [Environmental Setting] window ([Key Windows]). 
For the details, refer to the following.

➟5.2.4 ■4 [Key Window]

■12 Using the device monitor
You can monitor the virtual devices of a controller connected to the GOT offline monitor using the device monitor.

(1) Specifications of the device monitor
(a) Starting the device monitor

You can start the device monitor only during monitoring when connection is established between the GOT offline monitor 
and the GX Works3 offline monitor.

(b) Monitoring-supported devices
With the device monitor function, the GOT internal devices, GT SoftGOT2000 internal devices, and virtual devices of the 
controllers can be monitored.
For the devices that can be monitored by the GOT offline monitor, refer to the following.

Keyboard operation GOT key code Operation on the numerical input Operation on the text input

[Back space] 0008h Delete the character on the cursor.

[Enter]*1 000Dh Write the entry to a specified device, display the cursor on the target object, move the cursor 
to a different object, or close the key window.

[Esc] 001Bh Cancel the entry.

[-] (Hyphen) 002Dh Reverse the sign of the value. -

[.] (Period) 002Eh Enter a decimal point. -

[0] to [9] 0030h to 0039h Enter a numeric character.

Enter a character. (ASCII or Unicode 2.1-
compatible)[A] to [Z], [a] to [z] 0041h to 005Ah, 0061h to 

007Ah
Enter a numeric character in hexadecimal ([A] 
to [F], [a] to [f]).

Symbol keys Character codes (ASCII) -

Enter text (such as hiragana 
or kanji characters).

Character codes (Unicode) - Enter text. (Unicode 2.1-compatible)

[→], [←], [↑], [↓] 0080h, 0081h, 0082h, 0083h Move the cursor to a different object.

[Home] 0084h - Convert the entry to kanji or Simplified 
Chinese characters.

[Page Up] 0085h - Select the previous candidate.

[Page Down] 0086h - Select the next candidate.

[End] 0087h

-

Confirm the entry,
or select the next group of hiragana 
characters to be converted to kanji 
characters.

[Delete] 0088h Delete all the entered characters.

[Ctrl] + [←], [Ctrl] + [→] 0090h, 0091h Move the cursor on the target object.

[Ctrl] + [↑], [Ctrl] + [↓] FFFAh, FFFBh Increment or decrement the value. -
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➟11.15.1 ■6 Monitoring-supported devices

(c) Specifications of the free registration list
A created free registration list is retained after exiting the GOT offline monitor.
Up to 32 free registration lists can be created.
Up to 32 characters are available for a free registration list name.
The following characters cannot be used in a free registration list name.
\ / : ; * ? " < > | .
Up to 6 free registration windows can be open simultaneously.
Up to 256 devices are registrable in one free registration list.

(2) Starting the device monitor
Perform one of the following operations during monitoring to start the device monitor.

• Select [Tool] → [Start of Device Monitor] from the menu.
• Click the [Device Monitor] button on the toolbar.
• Select [Tool] → [Start of Device Monitor] from the right-click context menu.

(3) Ending the device monitor
Perform one of the following operations to exit the device monitor.

• Select [Tool] → [End of Device Monitor] from the menu of the GOT offline monitor.
• Select [File] → [Exit] from the menu of the device monitor.
• Click the [Close] button on the title bar of the device monitor.
• On the GOT offline monitor, select [Tool] → [End of Device Monitor] from the right-click context menu.
• Ending the GOT offline monitor

(4) Creating or editing a free registration list
Register a device in a free registration list to test the device for correct operation.
After changing the device value, you can check the project operations.
The following shows the procedure for creating or editing a free registration list.

Step 1 Perform one of the following operations to display a free registration window.
• Select [Window] → [New Free Registration List] from the menu.
• Double-click [New] under [Free Reg] in the [Project] window.
• Double-click a target free registration list under [Free Reg] in the [Project] window.

For information on how to import a free registration list and add it as a new list, refer to the following.
➟11.15.2 ■12 (7) Importing a free registration list

Step 2 Register, edit or delete a device in the free registration window.

➟(16) Free registration window

(5) Changing the name of a free registration list
Select a free registration list, and click it again or press the [F2] key on the keyboard to edit its name.

(6) Deleting a device
Select a device and press the [Delete] key on the keyboard to delete the device.

(7) Importing a free registration list
Import a free registration list file in the CSV or Unicode text format.
The following shows the procedure for importing a free registration list.

Step 1 Perform one of the following operations in the [Project] window according to the import method.
• To import a free registration list and add it as a new list, select [New].
• To overwrite an existing free registration list with an imported list, select the target existing free 

registration list.
• To import multiple free registration lists, select [Free Reg] at the top of the tree.

Step 2 Perform one of the following operations to display the [Open] dialog.
• Select [File] → [Import Free Registration List] from the menu.
• In the [Project] window, click the [Im] button.
• Right-click the item selected in step 1, and select [Import] from the menu.

Step 3 Select a free registration list file and click the [Open] button to import the file.
When importing multiple files, you can import CSV files and Unicode text files together.
For the precautions for using a CSV file or Unicode text file, refer to the following.

➟12.8 Precautions for Using CSV File
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12.9 Precautions for Using Unicode Text File

(8) Exporting one free registration list at a time
The following shows the procedure for exporting one free registration list at a time to a CSV or Unicode text file.

Step 1 In the [Project] window, select a free registration list to be exported.
Step 2 Perform one of the following operations to display the [Save As] dialog.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click the free registration list to be exported, and select [Export] from the menu.

Step 3 Set [File name] and [Save as type], and click the [Save] button to export the free registration list.

(9) Exporting all free registration lists
The following shows the procedure for exporting all free registration lists to CSV or Unicode text files.

Step 1 In the [Project] window, select [Free Reg] at the top of the tree.
Step 2 Perform one of the following operations to display a dialog where you can select a file format.

• Select [File] → [Export Free Registration List] from the menu.
• In the [Project] window, click the [Ex] button.
• Right-click [Free Reg] at the top of the tree, and select [Export] from the menu.

Step 3 Select a file format and click the [OK] button to display the [Browse For Folder] dialog.
Step 4 Select an export destination and click the [OK] button to export the free registration lists.

(10)Layout of an exported free registration list.
The exported free registration lists are editable with spreadsheet software or others.
The following shows the layout of an exported free registration list.

1) Version
Version of the free registration list

2) List type
Type of a list

• 0: Free registration list
3) List name

Name of the free registration list
For the name specifications, refer to the following.

➟11.15.2 ■12 (1) (c) Specifications of the free registration list
4) Number of devices

Number of the registered devices
Up to 256 devices are registrable in one free registration list.

5) No.
Registered device number

6) Device
Registered device

7) Data type
Data type of a device

• BIT: [Bit]
• BIN8: [Byte [Signed]]
• BIN8_Unsigned: [Byte [Unsigned]/Bit String [8-bit]]
• BIN16: [Word [Signed]]

1)
2)

3)
4)

5)

6) 7) 8) 9)
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• BIN16_Unsigned: [Word [Unsigned]/Bit String [16-bit]]
• BIN32: [Double Word [Signed]]
• BIN32_Unsigned: [Double Word [Unsigned]/Bit String [32-bit]]
• BIN64: [Quad Word [Signed]]
• BIN64_Unsigned: [Quad Word [Unsigned]/Bit String [64-bit]]

8) Display format
Display format of a device

• BIN: [Binary]
• OCT: [Octal]
• DEC: [Decimal]
• HEX: [Hexadecimal]

9) Comment
Comment set for a device
Up to 255 characters can be entered per comment.

(11)Deleting a free registration list
The following shows the procedure for deleting a free registration list.

Step 1 In the [Project] window, select a free registration list to be deleted.
Step 2 Perform one of the following operations to display a confirmation dialog.

• Press the [Delete] key on the keyboard.
• Right-click the free registration list to be deleted, and select [Delete] from the menu.

Step 3 Click the [Yes] button to delete the list.

(12)Precautions for the device monitor
(a) Monitoring performance of the GOT offline monitor

An increase in the number of monitored devices causes monitoring performance degradation in the GOT offline monitor.

(b) Precautions for exporting a free registration list
When a free registration list contains characters that cannot be represented in ASCII or Shift JIS code, export the list to 
a Unicode text file.
If you export the list to a CSV file, such characters are not output properly.
For the precautions for using a Unicode text file, refer to the following.

➟12.9 Precautions for Using Unicode Text File
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(13)[Device Monitor] window

1) Title bar
Displays the device monitor operation status.

2) Menu bar
Displays the operation menus of the device monitor.

➟(14) Menus
3) Toolbar

Displays the operation buttons of the device monitor.
➟(15) Toolbar

4) [Project] window

5) Work window
An area in which free registration windows appear

➟(16) Free registration window
6) Editor tab

Displays the tabs corresponding to the windows opened in the work window.
To bring an open window to the foreground in the work window, select its tab.

7) Status bar
Displays the description of a selected menu.

• Expand all button, collapse all button
Expands or collapses all items in the tree.

• [Im] button
Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the following.
➟11.15.2 ■12 (7) Importing a free registration list

• [Ex] button
Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the following.
➟11.15.2 ■12 (8) Exporting one free registration list at a time
11.15.2 ■12 (9) Exporting all free registration lists

• [Free Reg]
Displays created free registration list names.

• [New]
Creates a free registration list.

• Pull-down menu button
Lists the open windows in the work window.
To bring an open window to the foreground in the work window, select it from 
the pull-down menu.

1)
2)

3)

5)

6)

4)

7)

Expand all button, collapse all button

Pull-down menu button
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(14)Menus
(a) [File]

(b) [View]

(c) [Online]

(d) [Window]

(e) [Help]

Menu Description Shortcut key

[Import Free Registration List]

Import a free registration list file in the CSV or Unicode text format.
For the procedure for importing a free registration list, refer to the 
following.

➟11.15.2 ■12 (7) Importing a free registration list

Alt+I

[Export Free Registration List]

Export a free registration list to a CSV or Unicode text file.
For the procedure for exporting a free registration list, refer to the 
following.

➟11.15.2 ■12 (8) Exporting one free registration list at a time
11.15.2 ■12 (9) Exporting all free registration lists

Alt+E

[Exit] Ends the device monitor. -

Menu Description Shortcut key

[Toolbar] Displays or hides the toolbar. -

[Status Bar] Displays or hides the status bar. -

Menu Description Shortcut key

[Start] Starts the device monitor. F3

[Stop] Stops the device monitor. Alt+F3

Menu Description Shortcut key

[New Free Registration List] Create a free registration list. -

[Cascade] Displays open windows in a stack in the work window. -

[Arrange Sideways] Tiles open windows side by side in the work window. -

[Arrange Lengthways] Tiles open windows horizontally in the work window. -

[Close Inactive Windows] Closes all open windows except the selected one in the work 
window. -

[New Horizontal Tab Group]

Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in 
a pane immediately underneath the current pane.
Tabs are movable between the editor tabs of panes.

-

[New Vertical Tab Group]

Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in 
the immediately right pane.
Tabs are movable between the editor tabs of panes.

-

Menu Description Shortcut key

[GT Designer3 Help] Displays GT Designer3 Help. F1
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(15)Toolbar

1) [Start the communication] button
Starts the device monitor.

2) [Stop the communication] button
Stops the device monitor.

3) [Display all open windows in a stack (cascade)] button
Displays open windows in a stack in the work window.

4) [Display all open windows in a horizontal direction] button
Tiles open windows side by side in the work window.

5) [Display all open windows in a vertical direction] button
Tiles open windows horizontally in the work window.

6) [Close all the inactive windows] button
Closes all open windows except the selected one in the work window.

7) [Create a new horizontal tab group] button
Splits the work window into panes horizontally.
Puts the free registration window corresponding to a selected tab in a pane immediately underneath the current 
pane.
Tabs are movable between the editor tabs of panes.

8) [Create a new vertical tab group] button
Splits the work window into panes vertically.
Puts the free registration window corresponding to a selected tab in the immediately right pane.
Tabs are movable between the editor tabs of panes.

9) [Display GT Designer3 Help] button
Displays GT Designer3 Help.

1)
2)

3)
4)

5)
6)

7)
8)

9)
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(16)Free registration window

1) [Device]
Set a device to be monitored.

➟6.1.2 How to set devices
2) [Data Type]

Select the data type of a device.
The following shows selectable items.

• [Bit]
• [Byte [Unsigned]/Bit String [8-bit]]
• [Word [Unsigned]/Bit String [16-bit]]
• [Double Word [Unsigned]/Bit String [32-bit]]
• [Quad Word [Unsigned]/Bit String [64-bit]]
• [Byte [Signed]]
• [Word [Signed]]
• [Double Word [Signed]]
• [Quad Word [Signed]]

3) [Current Value]
Displays the current value of a device.
The set value is user-changeable.
If a communication error occurs, [--] is displayed.
The setting range of [Current Value] depends on the device.

4) [Display Format]
Select the display format of a device.
The following shows selectable items.

• [Binary]
• [Octal]
• [Decimal]
• [Hexadecimal]

5) [Comment]
Set a comment for a device.
Up to 255 characters can be entered per comment.

1) 2) 3) 4) 5)
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■13 Referring to the resource data
Refer to the alarm log files, recipe files, data log files, operation log files, and image files (such as hard copies) saved in 
a personal computer.

Step 1 Perform one of the following operations to display the [Refer To Resource Data] dialog.
• Select [Tool] → [Resource Data] from the menu.
• Click the [Resource Data] button on the toolbar.
• Select [Tool] → [Resource Data] from the right-click context menu.

Step 2 Configure the following settings and click the [Open] button to display the resource data.

1) [Look in]
Select the storage location of resource data.

2) [File Name]
Select resource data to be referred to.

3) [Files of type]
Select the file type of resource data.

• CSV Files (*.csv): CSV format
• Unicode Text Files (*.txt): Unicode text format
• Bitmap Files (*.bmp): BMP format
• JPEG Files (*.jpg): JPEG format

■14 Displaying a script error
Displays the script error information.
For the script function, refer to the following.

➟9.9 Project Script, Screen Script, and Script Part
Step 1 Perform one of the following operations.

• Select [Tool] → [Script Error] from the menu.
• Select [Tool] → [Script Error] from the right-click context menu.

Step 2 The [Script Error Info.] dialog is displayed.

1) [Script No.]
The script number of the script in which an error occurs is displayed.

2) [Error No.]
The error code of the error is displayed.

3) [Error message]

1)

2)
3)

1)
3)

2)

4)

5)
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Displays the error contents.
4) [Retry flag] button

Retries the script.
If a screen in which no script runs is displayed on the simulator screen, the retry is not performed.

5) [Clear] button
Clears the displayed error message by performing the following.
If a screen in which no script runs is displayed on the simulator screen, the error message is not cleared.

• GS14.b0, b7, b8, and b12 store 0.
• GS15 stores -1.
• GS16 to GS47 store 0.

For the details of the GOT internal devices, refer to the following.
➟12.1.3 GOT special register (GS)

When the error has not been cleared, the error message is displayed again.

■15 Displaying an object script error
Displays the object script information.
For the object script function, refer to the following.

➟9.10 Object Script
Step 1 Perform one of the following operations.

• Select [Tool] → [Object Script Error] from the menu.
• Select [Tool] → [Object Script Error] from the right-click context menu.

Step 2 The [Object Script Error Info.] dialog is displayed.

1) [Script User ID]
The user ID of the script in which an error occurs is displayed.

2) [Error No.]
The error code of the error is displayed.

3) [Error message]
Displays the error contents.

4) [Retry Flag] button
Retries the object script.
If a screen in which no script runs is displayed on the simulator screen, the retry is not performed.

5) [Clear] button
Clears the displayed error message by performing the following.
If a screen in which no script runs is displayed on the simulator screen, the error message is not cleared.

• GS80.b0, b7, b8, and b12 store 0.
• GS81 stores -1.
• GS82 to GS113 store 0.

For the details of the GOT internal devices, refer to the following.
➟12.1.3 GOT special register (GS)

When the error has not been cleared, the error message is displayed again.

1)
3)

2)

4)

5)
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■16 Displaying scroll bars
Step 1 Perform one of the following operations.

• Select [View] → [Scroll Bar] from the menu.
• Right-click the mouse and select [Scroll Bar] from the menu.

Step 2 A scroll bar appears.

(1) Displaying the scroll bar
When resolutions of the GOT model to be monitored are lower than the window size, the scroll bar is not 
displayed.

(2) Scrolling the screen
When the GOT offline monitor is activated, the screen can be scrolled by a wheel of a mouse.
The vertical scroll is prioritized.
Scrolling with the [PageUp] key and the [PageDown] key is unavailable.
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■17 Displaying a monitor screen in full screen mode
The monitor screen can be displayed on the personal computer in a full screen.

➟(1) Executing a full screen display
(2) Canceling a full screen display mode

(1) Executing a full screen display
Step 1 Perform one of the following operations.

• Press the [Alt] key and the [F9] key.
• Select the [View] → [Full Screen Mode] from the menu.
• Right-click the mouse and select [Full Screen Mode] from the menu.

Step 2 The confirmation dialog for switching the full screen display appears.
Click the [OK] button, and then the GOT offline monitor is displayed in a full screen.
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(2) Canceling a full screen display mode
Step 1 Perform one of the following operations.

• Press the [Alt] key and the [F9] key.
• Right-click the mouse and select [Full Screen Mode] from the menu.

Step 2 The confirmation dialog for switching the full screen display appears.
Click the [OK] button, and a full screen display mode is canceled.

(1) Operations during the full screen display
During the full screen display, some menu operations are not usable.
To use such operations, cancel the full screen display mode.

(2) Screen position during the full screen display
If a screen is switched to a full screen when resolutions of a personal computer are different from that of the 
project data, the GOT offline monitor is fixed to the upper left of the display of the personal computer.
The screen cannot be moved.
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11.15.3 Precautions for the GOT offline monitor

■1 Display of the GOT offline monitor and the GOT
The display of the GOT offline monitor may differ from the display of the GOT.
Check the actual display of the GOT.

■2 Numerical display
If an invalid numerical value is stored when [Real] is selected for [Display Format] of [Numerical Display], the invalid 
numerical value is displayed on the GOT offline monitor. ([non] is displayed on the GOT.)

■3 Clock display
The clock display during monitoring with the GOT offline monitor depends on the clock data of the personal computer. 
(The GOT reads the clock data of the PLC CPU to use it.)
The setting [Automatically adjust clock for daylight saving changes] in the personal computer is not applicable. Do not 
enable [Automatically adjust clock for daylight saving changes].

■4 Hard copy function
The settings of [Invert], [Writing Notification Device], and [Writing Error Notification Device] of the hard copy function 
cannot be monitored.
The system information about the hard copy function cannot be monitored.

■5 Printer output
(1) Printer output

The data cannot be output directly by the report function or hard copy function.
Data will be output to a file (TXT, CSV, or BMP format) on the hard disk of the personal computer. Output the file to a 
printer.

➟11.15.1 ■8 (2) For functions requiring the user to save data into a data storage

(2) When creating a table with the report function
Create a table as shown in example 1.
If a table is created as shown in example 2, the table will appear incorrectly in the output CSV file.

(3) When outputting the characters specified with a text print object by using the report function
Store characters in the specified devices according to the setting of [Display in order of High -> Low].
If the characters are not stored in the specified byte order, the characters are displayed incorrectly in the output CSV file.

➟8.32.5 [Text Print] dialog

(4) When using a project where the output trigger is set to turn on frequently
Make sure that your personal computer has enough free hard disk space, and delete the output files as necessary.
The output files will not be deleted automatically upon exit from the GOT offline monitor.

(5) When opening an output file on the personal computer
If you open an output TXT file by using a text editor such as WordPad or Notepad, character spacing may be misaligned 
on display.
If the character spacing is misaligned, adjust the character font or font size.
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(6) System alarm when the hard copy is executed
The system alarm is not displayed when the hard copy is executed.
For the troubleshooting for the hard copy, refer to the following.

■6 Sound output
(1) Personal computer conditions

The sound output function is executed with the sound function (sound card) or speaker of the personal computer.
If the personal computer to be used cannot output sound, the sound output function is unavailable.

(2) Unmuting the sound of the GOT offline monitor at its startup
If you mute the sound of the GOT offline monitor in Windows sound settings, the sound of the GOT offline monitor is 
automatically unmuted at its startup.
However, if you mute all sounds on Windows, the GOT offline monitor remains mute.

■7 When the project data has multiple channels
Only channel 1 can be monitored.
The other channels are ignored.
To monitor a device of other than channel 1, select [Search/Replace] → [Batch Edit] → [CHNo.] from the menu and set 
channel 1 for the debug target channel in GT Designer3.

Example) When channel 1 and 2 are used and channel 2 is to be monitored
Step 1 Change channel 1 to channel 3 in a batch.
Step 2 Change channel 2 to channel 1 in a batch.

For the batch edit of the channels, refer to the following.
➟11.8.4 Changing the set values in a batch (Batch Edit)

■8 Showing hidden folders
The following folder is a hidden folder.
Users\(user name)\AppData\Local

To display the hidden folder, configure the setting in Windows.
Example) Windows 10

Symptom Details of error and cause Corrective action

No files are output when the hard copy command is 
executed from the monitor screen.

The file cannot be saved due to problems with the 
output destination disk.

• Check that the folder specified as the virtual drive 
exists.

• Check the access privilege for the folder specified 
as the virtual drive.

• Check the disk space of the folder specified as the 
virtual drive.

The file cannot be saved since the file No. external 
control device value is not set within 1 to 9999.

Check that the file No. external control device value 
is set within 1 to 9999.
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■9 Recipe information
Clicking a special function switch to which [Recipe Information] is set displays the recipe operation window, regardless 
of the setting of [Enable recipe file operation on the monitor] in the [Recipe Common Setting] dialog.
To display the recipe information, click the [Recipe information] button in the simulation utility.

■10 Virtual drive V
To store image files in drive V and use them for parts displays, satisfy all the following conditions.

• Store the image files directly under drive V using the FTP server function that can run on Windows.
• Use IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg only for the file name and extension.
• Limit the total file size to less than 6 MB.
• Do not store any file other than IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg.

The files in drive V are deleted at the start or end of monitoring.
For details on parts displays, refer to the following.

➟8.8 Placing a Parts Display

■11 Precautions when the GOT type is GT SoftGOT2000
(1) Unavailable GOT internal devices

GOT internal devices (GS500 to GS507) are unavailable for the GOT offline monitor.

(2) Unavailable functions
The following functions are unavailable for the GOT offline monitor.

• Application start-up
• Mail send function
• SoftGOT-GOT link function
• Edgecross interaction function
• Display of file information in the PLC
• Interaction with PX Developer

■12 Reconnection after exiting the GX Works3 offline monitor
When the GOT offline monitor and the GX Works3 offline monitor are connected, exiting the GX Works3 offline monitor 
disconnects the GOT offline monitor.
For reconnection, start the GX Works3 offline monitor, and then start the GOT offline monitor and Resource File Viewer.

■13 When another station is set in the built-in Ethernet port setting in GX Works3
When another station is set in the built-in Ethernet port setting or station No. 0 is set for the module in GX Works3, the 
network information cannot be acquired automatically.
Apply the network information of GX Works3 to [Additional Allocation] in the [Setting] dialog ([Communication Setup] tab).

➟11.15.5 ■1 [Communication Setup] tab
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11.15.4 Screen layout of the GOT offline monitor

1) Title bar
Displays the project name.

2) Menu bar
Displays the operation menus of the GOT offline monitor.

➟■1 Menus
3) Toolbar

Displays the operation buttons of the GOT offline monitor.
➟■2 Toolbar

4) Monitor screen
Displays the monitor data.

5) Status bar
Displays the status of the GOT offline monitor.

■1 Menus
(1) [Project]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

4)

5)

Menu Description Shortcut key

[Snap Shot]
Saves a screen as a file.
(BMP format and JPEG format)

➟11.15.2 ■8 Capturing snap shots
Ctrl+H

[Print Setup]
Set a printer.

➟11.15.2 ■9 Printing a monitor screen
-

[Page Setup]
Adjusts the page layout for printing.

➟11.15.2 ■9 Printing a monitor screen
-

[Print Preview]
Displays a print preview.

➟11.15.2 ■9 Printing a monitor screen
-

[Print]
Outputs the settings of the project into a file.

➟11.15.2 ■9 Printing a monitor screen
Ctrl+P

[Properties] Displays the project information. -

[Exit] Exits the GOT offline monitor. Alt+F4
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(2) [View]

(3) [Set]

(4) [Online]

(5) [Tool]

(6) [Resource File Viewer]

Menu Description Shortcut key

[Scroll Bar]
Switches display or non-display of a scroll bar.

➟11.15.2 ■16 Displaying scroll bars
-

[Full Screen Mode]
Sets and cancels the full screen mode.

➟11.15.2 ■17 Displaying a monitor screen in full screen 
mode

Alt+F9

Menu Description Shortcut key

[Setting]
Displays the [Setting] dialog.

➟11.15.5 [Setting] dialog (GOT offline monitor)
-

[Keyboard]
Enables or disables the keyboard input.

➟11.15.2 ■11 Operating the numerical input or text input with 
a keyboard

-

Menu Description Shortcut key

[Monitor Start] Starts the GOT offline monitor. F3

[Monitor Stop] Stops the GOT offline monitor. Alt+F3

Menu Description Shortcut key

[Start of Device Monitor]
[End of Device Monitor]

Starts or ends the device monitor.

➟11.15.2 ■12 Using the device monitor
-

[Resource Data]
Refers to the resource data.

➟11.15.2 ■13 Referring to the resource data
Ctrl+R

[Script Error]
Displays the script error information.

➟11.15.2 ■14 Displaying a script error
-

[Object Script Error]
Displays the object script information.

➟11.15.2 ■15 Displaying an object script error
-

Menu Description Shortcut key

[Resource File Viewer Operation]
Displays the [Resource File Viewer Operation] dialog.

➟11.15.6 [Resource File Viewer Setting]/[Resource File 
Viewer Operation] dialog

-

[Start All] Starts all the Resource File Viewer modules enabled in the 
[Resource File Viewer Operation] dialog. -

[Activate All] Activates all the running Resource File Viewer modules. -

[End All] Ends all the running Resource File Viewer modules. -

[Start Resource File Viewer 1]
[End Resource File Viewer 1]

Starts or ends Resource File Viewer 1. -

[Start Resource File Viewer 2]
[End Resource File Viewer 2]

Starts or ends Resource File Viewer 2. -

[Start Resource File Viewer 3]
[End Resource File Viewer 3]

Starts or ends Resource File Viewer 3. -

[Start Resource File Viewer 4]
[End Resource File Viewer 4]

Starts or ends Resource File Viewer 4. -

[Start Resource File Viewer 5]
[End Resource File Viewer 5]

Starts or ends Resource File Viewer 5. -

[Start Resource File Viewer 6]
[End Resource File Viewer 6]

Starts or ends Resource File Viewer 6. -

[Start Resource File Viewer 7]
[End Resource File Viewer 7]

Starts or ends Resource File Viewer 7. -
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(7) [Help]

■2 Toolbar

1) [Start Monitoring] button
Starts the GOT offline monitor.

2) [Stop Monitoring] button
Stops the GOT offline monitor.

3) [Device Monitor] button
Starts or ends the device monitor.

4) [Start all Resource File Viewer] button
Starts all the Resource File Viewer modules enabled in the [Resource File Viewer Operation] dialog.

5) [End all Resource File Viewer] button
Ends all the running Resource File Viewer modules.

6) [Resource Data] button
Refers to the resource data.

7) [Setting] button
Displays the [Setting] dialog.

➟11.15.5 [Setting] dialog (GOT offline monitor)
8) [Keyboard]

Enables or disables the keyboard input.
9) Base screen number

Switch the number of the base screen to be displayed on the monitor screen from the pull-down menu or using the 
arrow buttons.

10) Window screen types
Select how to display the window screen to be displayed on the monitor screen.
The following shows selectable items.

• [Overlap 1]
• [Overlap 2]
• [Overlap 3]
• [Overlap 4]
• [Overlap 5]
• [Superimpose 1]
• [Superimpose 2]
• [Dialog]

11) Window screen number
Switch the number of the window screen to be displayed on the monitor screen from the pull-down menu.

12) Language switching setting
Select the column number for a comment group to be displayed.
The selectable numbers range from [1] to [30].

13) Screen security
Switch the security level.
The selectable levels range from [0] to [15].

[Start Resource File Viewer 8]
[End Resource File Viewer 8]

Starts or ends Resource File Viewer 8. -

Menu Description Shortcut key

[GT Designer3 Help] Displays GT Designer3 Help. F1

Menu Description Shortcut key

1) 2) 3) 4) 5) 6) 7) 8)

9) 10) 11) 12) 13)
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11.15.5 [Setting] dialog (GOT offline monitor)

Configure the option settings of the GOT offline monitor.
➟■1 [Communication Setup] tab
■2 [Action setup] tab
■3 [Auxiliary Setup] tab

■1 [Communication Setup] tab

1) [File Path]
Set the path to the recording file read from the GX Works3 offline monitor.

• When the GX Works3 offline monitor is not running
Click the [...] button to set the path to a recording file.

• When the GX Works3 offline monitor is running
Click the [Auto Acquisition] button to acquire the path to the recording file read from the GX Works3 offline 
monitor.

2) [Detail Setting >>] button, [Detail Setting <<] button
Displays or hides the network setting items.

3) [Auto Allocation]
Select the network information of the controllers to be monitored.

4) [Additional Allocation]
To monitor another station, set the network information of the target controller for monitoring.

5) [Behavior of the devices of the stations that are not to be monitored]
Select whether to monitor the devices of the station numbers not selected in [Auto Allocation] or [Additional 
Allocation].
The following shows selectable items.

• [Not monitor]
• [Monitor]

6) How to monitor the devices
Select how to display the devices when [Monitor] is selected for [Behavior of the devices that are not to be 
monitored].
The following shows selectable items.

• [Same as the devices to be monitored]
• [Display 0]

7) [CPU No. switching GD device first No. (3 points)]
Set the start device number of the GOT data registers (GD) to specify a CPU number.
The setting range is [0] to [65520].

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)
2)

3)

5)

7)

4)

6)
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Specify the value of [CPU No. switching GD device first No. (3 points)] set in the [Controller Setting] window in GT 
Designer3.
If you set a different number, proper monitoring is not performed.

■2 [Action setup] tab

1) [Resource File Viewer]
Configure the settings of Resource File Viewer.
Click the [Resource File Viewer Setting] button to display the [Resource File Viewer Setting] dialog.

➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
2) [Security]

Displays the authentication method set for the project data.
3) [Internal Device Retention Setting]

4) [Initialize SRAM user area when starting to monitor]
Initializes the SRAM user area at a start of monitoring.
The following functions save data to the SRAM user area.

• User alarm observation
• System alarm observation
• Logging
• Recipe
• Internal device retention

5) [All delete resource data after reading project data]
Deletes all the user data in the following folders at a start of monitoring.
Folder A, B, E, F, G or lower hierarchies in the working folder
For the working folder, refer to the following.

➟11.15.1 ■8 (3) Working folder

Item Description

[Retain internal device values in the 
embedded memory in cycles]

Saves the values of GOT internal devices to the SRAM user area at the specified intervals.
If this item is deselected, the values will be saved only when you exit the GOT offline 
monitor.

[Cycle]
Set a time interval to save the values of GOT internal devices to the SRAM user area.
The setting range is [1] minute to [60] minutes.

2)

3)

4)

1)

5)
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■3 [Auxiliary Setup] tab

1) [Display a project title in the title bar]
Displays the project name in the title bar.

2) [Terminate GOT Offline Monitor when disconnected from GX Works3 Offline Monitor]
Ends the GOT offline monitor at disconnection of the GX Works3 offline monitor.
If no PLC device is set in the common settings or object settings, this setting is disabled.

1)
2)
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11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog

This section explains startup of Resource File Viewer from the GOT offline monitor (linked startup).
For startup of Resource File Viewer directly from the RCFView.exe (independent startup), refer to the following.
➟11.16 Viewing an operation log file (Resource File Viewer)

Configure the settings for monitoring Resource File Viewer.
The dialog name depends on how to display the setting dialog.

1) [Resource File>>] button, [Resource File<<] button
This item is displayed in the [Resource File Viewer Operation] dialog.
Displays or hides the [Resource File] field.

2) No.
Select the Resource File Viewer modules to be started when selecting [Resource File Viewer] → [Start All] from the 
menu.

3) [File Path]
Set the path to the resource files to be displayed in Resource File Viewer.

4) [Resource File]
Select the extensions of the resource files to be displayed in Resource File Viewer.

5) [Resource File Viewer Operation]
This item is displayed in the [Resource File Viewer Operation] dialog.

Dialog name Display method

[Resource File Viewer Setting] dialog
Before starting the GOT offline monitor, click [Tools] → [GOT Offline Monitor] → [Set] from 
the menu, and click [Resource File Viewer Setting] in the [Setting] dialog ([Action setup] 
tab).

[Resource File Viewer Operation] dialog

Select [Resource File Viewer] → [Resource File Viewer Operation] from the menu of the 
GOT offline monitor.

Select [Set] → [Resource File Viewer Operation] from the menu of Resource File Viewer.

After starting the GOT offline monitor, click [Resource File Viewer Setting] in the [Setting] 
dialog ([Action setup] tab) in the GOT offline monitor.
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11
Select the operations for each Resource File Viewer module to be started.

6) [Select All] button
Selects all the resource file viewers.

7) [Deselect All] button
Deselects all the resource file viewers.

8) [Update All] button
This item is displayed in the [Resource File Viewer Operation] dialog.
Refresh all the displays of the running Resource File Viewer modules.

9) [Start All] button
This item is displayed in the [Resource File Viewer Operation] dialog.
Start all the Resource File Viewer modules targeted to start.

10) [Activate All] button
This item is displayed in the [Resource File Viewer Operation] dialog.
Activates all the Resource File Viewer modules.

11) [End All] button
This item is displayed in the [Resource File Viewer Operation] dialog.
Ends all the Resource File Viewer modules.

12) [Start monitoring when starting Resource File Viewer]
Starts monitoring at a start of a Resource File Viewer module.

13) [Specify the resource file to be displayed when starting Resource File Viewer]
Specify the type of the resource files to be displayed at a start of a Resource File Viewer module.
The following shows selectable file types.

• [User Alarm]
• [System Alarm]
• [Operation Log]

Item Description

[Update] button Refreshes the display of the running Resource File Viewer module.

[Start] button Starts Resource File Viewer.

[Activate] button Activates Resource File Viewer.

[End] button Ends Resource File Viewer.
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11.15.7 How to use a Resource File Viewer module

This section explains startup of Resource File Viewer from the GOT offline monitor (linked startup).
For startup of Resource File Viewer directly from the RCFView.exe (independent startup), refer to the following.
➟11.16 Viewing an operation log file (Resource File Viewer)

Monitors the resource files read from the GOT.
The following shows the monitoring-supported resource file types.

• User alarm (G2A, CSV, TXT)
• System alarm (G2A, CSV, TXT)
• Operation log (G2O, CSV, TXT)

■1 Starting monitoring with a Resource File Viewer module
Establish connection between the GX Works3 offline monitor and the GOT offline monitor to start monitoring.
Start a Resource File Viewer module from the GOT offline monitor.

Step 1 Use one of the following methods to start a Resource File Viewer module.
• Select [Resource File Viewer] → [Start All] from the menu.
• Select [Resource File Viewer] → [Start Resource File Viewer n] from the menu (n = 1 to 8).
• Click the [Start all Resource File Viewer] button on the toolbar.

Step 2 At the first startup, set the resource files to be read to a Resource File Viewer module.
When the [Resource File Viewer Operation] is displayed, set the resource files to be displayed in Resource 
File Viewer, and click the [Activate] button or [Activate All] button to start monitoring.

➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
After the first startup, the resource files set in the [Resource File Viewer Operation] dialog are read and 
monitoring starts.

■2 Updating the resource files
(1) When the storage destination of the resource files has been changed

Step 1 Display the [Resource File Viewer Operation] dialog and change the setting of the [File Path].

➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
Step 2 Click the [Update] button to update the resource files displayed in Resource File Viewer.

(2) When a resource file has been changed, added, or deleted
Step 1 Perform either of the following operations.

• Click the [Update] button in the [Navigation] window of Resource File Viewer.
• Click the [Update] button in the [Resource File Viewer Operation] dialog

➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
Step 2 The resource files displayed in Resource File Viewer are updated.

■3 Exiting Resource File Viewer
Disconnect the GX Works3 offline monitor to stop monitoring.
Exit the GOT offline monitor or Resource File Viewer.

(1) Exiting the GOT offline monitor
Exit Resource File Viewer by either of the following methods.

• Select [Resource File Viewer] → [End All] from the menu.
• Select [Resource File Viewer] → [End Resource File Viewer n] from the menu (n = 1 to 8).
• Click the [End all Resource File Viewer] button on the toolbar.
• Click the [End] button in the [Resource File Viewer Operation] dialog

➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog
• Exit the GOT offline monitor.
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11
(2) Exiting Resource File Viewer
Exit Resource File Viewer by either of the following methods.

• Select [Project] → [Exit Application] from the menu.
• Click the [×] button.

■4 Searching for the logs in the resource files
(1) Searching for the logs by specifying a keyword or a date and time value

Step 1 Perform either of the following operations to display the [Search] dialog.
• [Ctrl] key + [F] key
• Select [Search] → [Search] from the menu.

➟11.15.8 ■4 [Search] dialog
Step 2 Set the search criteria and click the [Search] button to display the found logs in the search result list.

Step 3 When monitoring is inactive, double-click any of the logs in the search result list to select the corresponding 
log in the resource file display area.

➟11.15.8 Screen layout of a Resource File Viewer module

(2) Exporting the search result list data
Step 1 Search for the logs using the [Search] dialog.

➟(1) Searching for the logs by specifying a keyword or a date and time value
Step 2 Click the [Export] button to display the [Save As] dialog.
Step 3 Set [File name] and [Save as type] and click the [Save] button to export the search result list.

Search criteria

Search result list
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■5 Changing the items to be displayed in the resource file display area
Step 1 Select [View] → [Display Items] from the menu to display the [Display Item Setting] dialog.

Step 2 Select the items to be displayed in the resource file display area and specify their display order.
For details on the operation buttons, refer to the following.

➟11.15.8 ■5 [Display Item Setting] dialog (Resource File Viewer)

■6 Switching the display language of Resource File Viewer
The following shows how to switch the display language of Resource File Viewer.

Step 1 Select [View] → [Switch Display Language] from the menu to display the [Display Language] dialog.

Step 2 Select a language to be switched to in [Display Language] and click the [OK] button.

■7 Switching the display language of the resource files
When the resource files are binary format files, the display language can be switched.
How to switch the display language depends on the resource file type.

• User alarm
The data are displayed in the display language set in the toolbar of the GOT offline monitor before Resource File 
Viewer is started.

➟11.15.2 ■5 Switching the display language
• System alarm, operation log

The data are displayed in the system language set in the GOT offline monitor before Resource File Viewer is started.
➟5.2.2 Setting for switching the language displayed on the GOT ([Language Switching])

1)
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■8 Setting the resource files to be monitored in a Resource File Viewer module
Set the storage destinations and file types of the resource files to be read to each Resource File Viewer module.

Step 1 Perform one of the following operations to display the [Resource File Viewer Setting] dialog or [Resource 
File Viewer Operation] dialog.

• Click the [Resource File Viewer Setting] button in the [Setting] dialog ([Action setup] tab) of the GOT 
offline monitor.

• Select [Resource File Viewer] → [Resource File Viewer Operation] from the menu of the GOT offline 
monitor.

• Select [Set] → [Resource File Viewer Operation] from the menu of Resource File Viewer.
➟11.15.6 [Resource File Viewer Setting]/[Resource File Viewer Operation] dialog

Step 2 Set the storage destinations and file types, and extensions of the resource files to be read, and click the [OK] 
button.

Storage destinations of the resource files Resource file types, extensions
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■9 Monitoring the logs by synchronizing the clock time with GX Works3 offline monitor
This is available while connection is established between the GOT offline monitor and the GX Works3 offline monitor.

(1) Reading the clock time of the GX Works3 offline monitor
By reading the clock time of the GX Works3 offline monitor to a Resource File Viewer module, the logs collected at the 
same time as the events occurred in the GX Works3 offline monitor can be monitored.

Step 1 Perform either of the following operations in Resource File Viewer.
• Select [Online] → [Start Monitoring] from the menu.
• Click the [Adjust date and time of Resource File Viewer to those of GX Works3 Offline Monitor.] button.

➟11.15.8 Screen layout of a Resource File Viewer module
Step 2 The logs collected at the same time as the events occurred in GX Works3 offline monitor are selected in the 

resource file display area.

(2) Writing the clock time of a Resource File Viewer module
By writing the clock time of a Resource File Viewer module to the GX Works3 offline monitor, the events occurred at the 
same time as the logs are collected can be monitored.

Step 1 Select any of the logs in the resource file display area and perform either of the following operations.
• Click the [Adjust date and time of GX Works3 Offline Monitor to those of Resource File Viewer.] in 

Resource File Viewer.
• Double-click the log selected in the resource file display area.

(This is available when [Read/write GX Works3 Offline Monitor time on a selected date and time] in the 
[Action Setup] dialog is selected.)
➟11.15.8 Screen layout of a Resource File Viewer module

Step 2 The events occurred at the same clock time as Resource File Viewer are selected in the GX Works3 offline 
monitor.
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11.15.8 Screen layout of a Resource File Viewer module

This section explains startup of Resource File Viewer from the GOT offline monitor (linked startup).
For the screen layout of Resource File Viewer when starting it directly from the RCFView.exe (independent 
startup), refer to the following.
➟11.16.3 Screen layout of Resource File Viewer (at independent startup)

1) Title bar
Displays the module number of Resource File Viewer and monitoring status.

2) Menu bar
Displays the operation menus of Resource File Viewer.

➟■1 Menus
3) [Navigation] window

Lists the resource files.

4) [Display File Information] button
Displays the [Display File Information] dialog.

➟■2 [Display File Information] dialog
5) Resource file display area

Displays the details of the resource file selected in the [Navigation] window.

• [Unfold All] button, [Fold All] button
Expands or collapses all items in the tree.

• [!]
Appears when a resource file has been updated, added, deleted, or 
renamed.

• [Update] button
Updates the resource files.

• Resource file list
Displays the resource files with the extensions selected in 
[Resource File] in the [Resource File Viewer Setting] dialog or 
[Resource File Viewer Operation] dialog.
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10)
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[Unfold All] button, [Fold All] button

Resource file list
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Set the display items in the [Display Item Setting] dialog.
➟■5 [Display Item Setting] dialog (Resource File Viewer)

6) [Detail Display] button
Displays the [Detail Display] dialog.

➟■3 [Detail Display] dialog
7) Arrow buttons

Switches between the resource files displayed in the resource file display area.
8) [Adjust date and time of Resource File Viewer to those of GX Works3 Offline Monitor.] button

Selects the logs collected at the same clock time as the GX Works3 offline monitor.
9) [Adjust date and time of GX Works3 Offline Monitor to those of Resource File Viewer.] button

Selects the events occurred at the same clock time as the resource file viewer.
10) Status bar

Displays the time read from the GX Works3 offline monitor.

■1 Menus
(1) [Project]

(2) [Search]

(3) [View]

(4) [Online]

(5) [Set]

(6) [Help]

Menu Description Shortcut key

[Exit Application] Exits Resource File Viewer. Alt+F4

Menu Description Shortcut key

[Search]
Search for the resource files read to Resource File Viewer.

➟■4 [Search] dialog
Ctrl+F

Menu Description Shortcut key

[Navigation] Displays or hides the [Navigation] window. -

[Display Items]
Select the items to be displayed in the resource file display 
area.

➟■5 [Display Item Setting] dialog (Resource File Viewer)
-

[Switch Display Language]
Switch the display language of Resource File Viewer.

➟11.15.7 ■6 Switching the display language of Resource File 
Viewer

-

Menu Description Shortcut key

[Start Monitoring] Establish connection between the GX Works3 offline monitor 
and the GOT offline monitor to start monitoring. F3

[Stop Monitoring] Disconnects the GX Works3 offline monitor to stop monitoring. Alt+F3

Menu Description Shortcut key

[Resource File Viewer Operation]
Configure the settings of Resource File Viewer.

➟11.15.6 [Resource File Viewer Setting]/[Resource File 
Viewer Operation] dialog

-

[Action Setup]
Configure the settings of the resource file display area.

➟■6 [Action Setup] dialog
-

Menu Description Shortcut key

[GT Designer3 Help] Displays GT Designer3 Help. F1
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■2 [Display File Information] dialog
Displays the information of the resource file selected in the [Navigation] window.
The displayed items depend on the resource file type.

Example) User alarm, system alarm

Item Description

Data Structure Version The version of the data structure

System ID
Alarm ID
(For system alarms, this item is fixed to 65535.)

System Name
The name of the alarm
(For system alarms, this item is blank.)

Number of Data The number of logs

Comment Group No.: General
The No. of the basic comment group
(For system alarms, this item is fixed to 0.)

Comment Group No.: Middle
The No. of the middle level comment group
(For system alarms, this item is fixed to 0.)

Comment Group No.: Upper
The No. of the upper level comment group
(For system alarms, this item is fixed to 0.)

Comment Group No.: Detail
The No. of the detailed comment group
(For system alarms, this item is fixed to 0.)

History Number The number of alarms

Generated Number The number of uncorrected alarms

Number of Unconfirmed Alarms The number of unconfirmed alarms

Date Order The order of the dates

Difference from GMT The difference from the Greenwich Mean Time

Time Information Order The order of output time
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■3 [Detail Display] dialog
Displays the details of the logs selected in the resource file display screen.
The displayed items depend on the resource file type.

(1) User alarm

(2) System alarm

Item Description

Upper Comment No. The No. of the upper level comment

Middle Comment No. The No. of the middle level comment

Comment No. The No. of the basic comment

Comment The comment of the basic alarm

Alarm Status

The status of the alarm
• O: Occurring, not confirmed
• OC: Occurring, confirmed
• R: Restored, not confirmed
• RC: Restored, confirmed

Occurred The date and time on which the alarm occurred

Restored The date and time on which the alarm was corrected

Checked The date and time on which the alarm was confirmed

Level The level set for the alarm

Group The group set for the alarm

Frequency of Occurrences The number of alarms that occurred

Cumulative Down Time Cumulative down time

Down Time Down time

Item Description

Error No. The No. of the error

Comment System alarm message

Alarm Status

The status of the alarm
• O: Occurring, not confirmed
• OC: Occurring, confirmed
• R: Restored, not confirmed
• RC: Restored, confirmed

Occurred The date and time on which the alarm occurred

Restored The date and time on which the alarm was corrected

Checked The date and time on which the alarm was confirmed

CH No. Channel No.

Network/Station No./No. Network No., station No., and module No.

Device The name of the device
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(3) Operation log
The output items depend on the operations to be recorded.
For the output items and information for each operation, refer to the following.

➟5.2.11 ■1 (2) Output items of operation logs

■4 [Search] dialog
Searches for the resource files displayed in the [Navigation] window.

1) [Search Target]
Select the file type of the resource data to be searched for.
The following shows selectable items.

• [User Alarm]
• [System Alarm]
• [Operation Log]

2) [Search Mode]
Select the method of searching.
The following shows selectable items.

• [Date/Time]
• [Keyword]

3) [Date/Time]

Screen Type

The type of the screen
• BASE: Base screen
• OVL1 to OVL5: Overlap windows 1 to 5
• SPI1 to SPI2: Superimpose windows 1 to 2
• DLG: Dialog window
• PNL: Operation panel
• KEY: Key window
• RPT: Report screen

Definition Screen No.

The No. of the definition screen
• B: Base screen
• W: Window screen
• R: Report screen

Object ID Object ID

Function Name Function Name

Drive Name The name of the drive

Item Description

1)

3)

4)

5)

6)

7)

8)

2)
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Set this field when [Search Mode] is set to [Date/Time].
The settings depend on the resource file type.

4) [Keyword]
Enter here when [Search Mode] is set to [Keyword].
Specify the keyword for a search in the resource files.
Up to 1024 characters can be entered.
The characters are case-sensitive.
After a search with [Keyword] left blank, the search result will be 0.

5) [Search] button
Start searching.
Search results are displayed in the search result list.

6) Search result list
Lists the search results.
When monitoring is interrupted, double-click any of the logs in the search result list to select the corresponding log 
in the resource file display area.

7) [Search Result]
The number of the resource files are displayed in the search result list.

8) [Export]
Saves the search result list as a CSV file or a Unicode text file.
Set [File name] and [Save as type] in the displayed dialog and click the [Save] button to export the search result list.

■5 [Display Item Setting] dialog (Resource File Viewer)

1) [Setting Target]
Select the file type of the resource data set as the display items.
The following shows selectable items.

• [User Alarm]
• [System Alarm]

Resource file type Setting

User alarm and system alarm log files

Select the date and time targeted for a search.
The following shows selectable items.
• [Occurred]
• [Restored]
• [Checked]
Based on the selection above, select the search period.
The following shows selectable items.
• [Exact Match]
• [On or Before]
• [On or After]
• [Range]

Operation log file

Based on the recorded dates and time of the operation logs, select the search period.
The following shows selectable items.
• [Exact Match]
• [On or Before]
• [On or After]
• [Range]

4)2)

3)

1)
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• [Operation Log]
2) [Display Options]

Options of the items displayed in the search result list
Select an item and click the [Select] button to move the item to [Display Items].

3) Operation buttons

4) [Display Items]
Items to be displayed in the search result list
If any item is selected and the [Delete] button is clicked, the selected item is moved to [Display Options].
The items in the search result list are displayed in the order set for [Display Items].

If any item is selected and the [Up] button or the [Down] button is clicked, the position of the selected item is moved 
upward or downward.

■6 [Action Setup] dialog

1) [Behavior when a selected row is double-clicked]
Select the behavior when a log selected in the resource file display area is double-clicked.

• [Display detailed contents of the resource file]
Displays the [Detail Display] dialog to show the details of the log.

• [Read/write GX Works3 Offline Monitor time on a selected date and time]
Write the clock time of the row selected in Resource File Viewer to the GX Works3 offline monitor to monitor 
the events occurred at the same clock time.

Item Description

[Select] button Moves the item selected in [Display Options] to [Display Items].

[Delete] button Moves the item selected in [Display Items] to [Display Options].

[Up] button, [Down] button Move the item selected in [Display Items] upward or downward.

[Select All] button Moves all the items in [Display Options] to [Display Items].

[Delete All] button Moves all the items in [Display Items] to [Display Options].

[Reset] button Restores the items in [Display Items] to the default ones.

The first item
The second item

The third item
The first item The second item The third item...

1)
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11.16 Viewing an operation log file (Resource File Viewer)
Start the Resource File Viewer exe directly, and the operation log file is viewable.
The operation log file read from the GOT is viewable on the personal computer without being converted in a CSV or 
Unicode text format.

➟11.16.1 Specifications of Resource File Viewer (at independent startup)
11.16.2 How to use Resource File Viewer (at independent startup)
11.16.3 Screen layout of Resource File Viewer (at independent startup)

This section explains direct startup of Resource File Viewer from the RCFView.exe (independent startup).
For startup of Resource File Viewer from the GOT offline monitor (linked startup), refer to the following.
➟11.15.7 How to use a Resource File Viewer module

11.15.8 Screen layout of a Resource File Viewer module

11.16.1 Specifications of Resource File Viewer (at independent startup)

➟■1 Operating environment of Resource File Viewer (at independent startup)
■2 Viewable operation log files
■3 Number of Resource File Viewer modules that can be started

■1 Operating environment of Resource File Viewer (at independent startup)
The operating environment of Resource File Viewer (at independent startup) is compliant with that of the GOT offline 
monitor.
For the operating environment of the GOT offline monitor, refer to the following.

➟11.15.1 ■1 Operating environment of the GOT offline monitor

■2 Viewable operation log files
Files with the following extensions are viewable.

• G2O
• CSV
• TXT

■3 Number of Resource File Viewer modules that can be started
Up to 16 Resource File Viewer modules can be started.
When a module is started, the smallest unused number from 1 to 16 is assigned to the module.
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11.16.2 How to use Resource File Viewer (at independent startup)

➟■1 Obtaining a resource file
■2 Starting Resource File Viewer
■3 Updating the resource files

■1 Obtaining a resource file
Before starting Resource File Viewer, obtain a resource file.
The following shows how to obtain a resource file.

For details on operation logs, refer to the following.
➟5.2.11 Configuring the settings for creating the operation history of the GOT ([Operation Log])

■2 Starting Resource File Viewer
The following shows how to start Resource File Viewer independently.

Step 1 Double-click the Resource File Viewer exe in the directory: (Path to the installation location of GT 
Designer3)\GTD3_2000\App\GSS3\RCFView\RCFView.exe.

Step 2 In the [Open resource file] dialog, select a resource file to be read to Resource File Viewer.
Click the [OK] button to start Resource File Viewer.

➟11.16.3 ■2 [Open resource file] dialog

■3 Updating the resource files
The following shows how to update the resource files or folder that stores the resource files.

(1) When the storage destination of the resource files has been changed
In the [Open resource file] dialog, set the path to the folder and click the [OK] button.

➟11.16.3 ■2 [Open resource file] dialog

(2) When a resource file has been changed, added, or deleted
Perform either of the following operations to update the resource files.

• Click the [Update] button in the [Navigation] window of the Resource File Viewer module.
• Click the [OK] button in the [Open resource file] dialog.

➟11.16.3 ■2 [Open resource file] dialog

Resource file source Method to obtain Reference

GOT

Obtaining a resource file using GT Designer3
➟4.8.2 [Communicate with GOT] dialog

Obtaining a resource file output to a USB memory or SD card

Obtaining a resource file from the GOT using Data Transfer 
Tool ➟Help For Data Transfer Tool

Obtaining a resource file output to the network drive ➟5.3.15 Configuring the network drive settings ([Network Drive])

Obtaining a resource file using the FTP server function ➟10.16 Transferring a File between the GOT and Peripheral Device 
(FTP Server Function)

GT Simulator3 Obtaining a resource file from the working folder ➟3.1.5 Destination to save data

GT SoftGOT2000 Obtaining a resource file from a virtual drive ➟GT SoftGOT2000 Version1 Operating Manual
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11.16.3 Screen layout of Resource File Viewer (at independent startup)

This section explains startup of Resource File Viewer directly from the exe (independent startup).
For the screen layout at startup of Resource File Viewer from the GOT offline monitor (linked startup), refer to 
the following.
➟11.15.8 Screen layout of a Resource File Viewer module

The following shows the screen layout of Resource File Viewer (at independent startup).

1) Title bar
Displays the Resource File Viewer module number and path to the displayed resource file.

2) Menu bar
Displays the operation menus of the Resource File Viewer module.

➟■1 Menus (at independent startup of a Resource File Viewer module)
3) [Navigation] window

Lists the resource files.

4) [File Information] button
Displays the [Display File Information] dialog.

➟11.15.8 ■2 [Display File Information] dialog
5) Resource file display area

Displays the details of the resource file selected in the [Navigation] window.
Set the display items in the [Display Item Setting] dialog.

➟11.15.8 ■5 [Display Item Setting] dialog (Resource File Viewer)

• [Unfold All] button, [Fold All] button
Expands or collapses all items in the tree.

• [!]
Appears when a resource file has been updated, added, deleted, or 
renamed.

• [Update] button
Updates the resource files.

• Resource file list
Displays the resource files with the extensions selected in the [Open 
resource file] dialog.

5)

7)

1)
2)

3)

6)

4)

[Unfold All] button, [Fold All] button

Resource file list

[Update] button
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6) [Detail Display] button
Displays the [Detail Display] dialog.

➟11.15.8 ■3 [Detail Display] dialog
7) Arrow buttons

Switches between the resource files displayed in the resource file display area.

■1 Menus (at independent startup of a Resource File Viewer module)
(1) [Project]

(2) [Search]

(3) [View]

(4) [Help]

Menu Description Shortcut key

[Exit Application] Exits the Resource File Viewer module. Alt+F4

[Open]
Select a resource file displayed in the resource file display 
area.

➟■2 [Open resource file] dialog
-

Menu Description Shortcut key

[Search]
Search for the resource files read to Resource File Viewer.
Only operation logs are searched for.

➟11.15.8 ■4 [Search] dialog
Ctrl+F

Menu Description Shortcut key

[Navigation] Displays or hides the [Navigation] window. -

[Display Items]

Select the items to be displayed in the resource file display 
area.
Only operation logs are selectable.

➟11.15.8 ■5 [Display Item Setting] dialog (Resource File 
Viewer)

-

[Switch Display Language]

Switch the display language of the Resource File Viewer 
module.

➟11.15.7 ■6 Switching the display language of Resource File 
Viewer

-

Menu Description Shortcut key

[GT Designer3 Help] Displays GT Designer3 Help. F1

[About Resource File Viewer]
Display the Resource File Viewer version.

➟■3 [About Resource File Viewer] dialog (at independent 
startup of a Resource File Viewer module)

-

11. USEFUL FUNCTIONS
11.16 Viewing an operation log file (Resource File Viewer)
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■2 [Open resource file] dialog

1) [Folder path]
Set the path to the resource file to be read to the Resource File Viewer module.

2) [Operation Log]
Select the types of operation logs displayed in the Resource File Viewer module.

• [G2O file]
• [CSV file]
• [Unicode text file]

When selecting a G2O file, select the language displayed in the Resource File Viewer module.
The following system languages can be selected.

• [Japanese]
• [English]
• [Chinese (Simplified)]
• [Chinese (Traditional)]
• [Korean]

■3 [About Resource File Viewer] dialog (at independent startup of a Resource File Viewer 
module)

Select [Menu] → [Help] → [About Resource File Viewer] to display the [About Resource File Viewer] dialog.

1)

2)
11 - 276 11. USEFUL FUNCTIONS
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12.1 GOT Internal Device

➟12.1.1 GOT bit register (GB)
12.1.2 GOT data register (GD)
12.1.3 GOT special register (GS)

The following data types cannot be used for GOT internal devices.
GOT bit register (GB): 64-bit
GOT data register (GD): 8-bit
GOT special register (GS): 8-bit, 64-bit

12.1.1 GOT bit register (GB)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device Function Supported 
models

GB0 to GB9 Use prohibited

GB10 to GB25 External Output for Y0 to YF

GB26 to GB29 Use prohibited

GB30 to GB37 External Input for X0 to X7

GB38 Without Power Supply

GB39 Clock Data Storage During ON

GB40 Always ON

GB41 Always OFF

GB42 ON When Screen Switching Occurs

GB43 to GB49 Use prohibited

GB50 to GB57 External Input for X8 To XF

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
12 - 2 12. APPENDICES
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■1 External Output for Y0 to YF (GB10 to GB25)
With the external I/O function, the signals are output to an external I/O device when the GB devices turn on.
The following shows the signal names for each GB device.

■2 External Input for X0 to X7 And X8 To XF (GB30 to GB37, GB50 to GB57)
With the external I/O function, the GB devices turn on when signals are input with an external I/O device.
The following shows the signal names for each GB device.

■3 Without Power Supply (GB38)
With the external I/O function, the GB devices turn on when the power for the external device is not supplied.

■4 Clock Data Storage during ON (GB39)
While this device is on, the clock data is stored to GD0 to GD6.
While this device is off, the clock data is not stored.

■5 Always ON (GB40)
Always ON

■6 Always OFF (GB41)
Always OFF

■7 ON When Screen Switching Occurs (GB42)
Turns on when switching the following screens occurs.

• Base screen
• Overlap window 1, 2, 3, 4, 5
• Superimpose window 1, 2
• When an overlap window is closed by opening a test window or others

You need to turn off this device.

GB58 to GB63 Use prohibited

GB64 to GB2047 User area

GB2048 to GB65535 User area

Device Function Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GB device Signal name GB device Signal name GB device Signal name GB device Signal name

GB10 Y0 output GB14 Y4 output GB18 Y8 output GB22 YC output

GB11 Y1 output GB15 Y5 output GB19 Y9 output GB23 YD output

GB12 Y2 output GB16 Y6 output GB20 YA output GB24 YE output

GB13 Y3 output GB17 Y7 output GB21 YB output GB25 YF output

GB device Signal name GB device Signal name GB device Signal name GB device Signal name

GB30 X0 input GB34 X4 input GB50 X8 input GB54 XC input

GB31 X1 input GB35 X5 input GB51 X9 input GB55 XD input

GB32 X2 input GB36 X6 input GB52 XA input GB56 XE input

GB33 X3 input GB37 X7 input GB53 XB input GB57 XF input
12. APPENDICES
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Actions of the Always ON (GB40) and the Always OFF (GB41)
Actions of the Always ON (GB40) and the Always OFF (GB41) are the same as those of b4 and b5 in the 
Common Information 1 (GS0), respectively.

12.1.2 GOT data register (GD)

GD devices are listed as follows.

■1 Storing clock data in GD devices (for GT21 and GS21)
While GB39 is on, the clock data is stored to GD0 to GD6.
For the details of the clock function, refer to the following.

➟5.3.5 Setting the GOT time setting method ([Time Setting])
The following shows the data to be stored to each GD device.

While GB39 is on, GD0 to GD6 are not usable as the user area.
To use GD0 to GD6 as the user area, turn off GB39.

Device Function Supported 
models

GD0 to GD2047 User area

GD2048 to GD65535 User area

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GD device Data to be stored

GD0 Second (0 to 59)

GD1 Minute (0 to 59)

GD2 Hour (0 to 23)

GD3 Date (1 to 31)

GD4 Month (1 to 12)

GD5 Year (2000 to 2037)

GD6 Day of the week (0 to 6)
12 - 4 12. APPENDICES
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■2 Designation of a station number using GD (only for the temperature controller connection, 
inverter connection and servo amplifier connection)

If 100 to 115 is set for a station number. in the setting of device, a station number can be designated by the value of GD10 
to GD25.
The monitor target station number can be changed by simply changing a device value.
For how to set the devices, refer to the following.

➟6.1 Device Settings

(1) When a GD device is used together with the Station No. Switching device (GT27, GT25, GT23, and 
GS25)
The station No.switching device has priority.

(2) When objects that monitor different channel numbers. are arranged on the same screen
To monitor different station Nos. by individual objects, use GD10 to GD25.
If station No. switching devices are used, the monitor target station number of an unintended object may be changed. 
(Especially when multiple switching target channel Nos. are set)
Example) When monitor target channel Nos. of station No. switching device are 1 and 2
The monitor target station Nos are switched at the timing of changing the value of GD10 to GD25.

Station No.1 Station No.2

150

Channel No.1

Channel No.2

(When using the Station No.Switching device)

(When GD (GD10 to GD25) is used)

Object 1

Object 2

100

200

Monitoring 
station No. 1 

of channel No. 1

Monitoring 
station No. 1 

of channel No. 2

Object 1

Object 2

100

200

2

2

1

Station No. 
Switching device:

When an attempt is made to 
switch the monitor target to 
station No. 2 only for object 1

Monitoring 
station No. 2 

of channel No. 1

Monitoring 
station No. 2 

of channel No. 2

All objects monitor station No. 2.

Monitoring 
station No. 1 

of channel No. 1

Monitoring 
station No. 1 

of channel No. 2

Object 1

Object 2

150

250

Object 1

Object 2

150

200

Object 1 GD10:

Object 1 GD11:

When an attempt is made to 
switch the monitor target to 
station No. 2 only for object 1

Only object 1 monitors station No. 2.

Monitoring 
station No. 2 

of channel No. 1

Monitoring 
station No. 1 

of channel No. 2

100

Station No.1 Station No.2

250200
12. APPENDICES
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12.1.3 GOT special register (GS)

The GOT special register includes the following two types.

Functions affected by GOT special register
Some GOT special registers affect multiple functions on the GOT.
For the relation between each GOT special register and GOT functions, refer to the following.
➟Settings related to each function

■1 Write device list

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Types Range Description

Write device GS0 to GS383, 
GS640 to GS1791

Writing values by the GOT notifies a user of the status of GOT.
➟■1 Write device list

Read device GS384 to GS639, 
GS1792 to GS2047

Writing values by a user controls the behavior of GOT.
➟■4 Read device list

Device Function Reference Supported 
models

GS0 Common Information 1 ➟12.1.3 ■2 (1) Common Information1 (GS0)

GS1 Base Screen Information ➟12.1.3 ■2 (2) Base Screen Information (GS1)

GS2 Use prohibited -

GS3 GOT ID No. ➟12.1.3 ■2 (3) GOT ID No. (GS3)

GS4
GS5

Use prohibited -

GS6

CC-Link G4 Station No. (CH1) ➟12.1.3 ■2 (4) CC-Link G4 Station No.(CH1) (GS6)

GOT Multidrop Slave Station No. (CH1) ➟12.1.3 ■2 (5) GOT Multidrop Slave Station No. 
(CH1) (GS6)

GS7 1 Second Binary Counter ➟12.1.3 ■2 (6) 1 Second Binary Counter (GS7)

GS8 Scan Time of Monitor ➟12.1.3 ■2 (7) Scan Time of Monitor (GS8)

GS9 Use prohibited -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
12 - 6 12. APPENDICES
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GS10 Scan Time of Monitor ➟12.1.3 ■2 (8) Scan Counter of Monitor (GS10)

GS11 to GS13 Use prohibited -

GS14 Script Common Information ➟12.1.3 ■2 (9) Script Common Information (GS14)

GS15 Script Error Pointer ➟12.1.3 ■2 (10) Script Error Pointer (GS15)

GS16 Script No.

➟12.1.3 ■2 (11) Script Error Data (GS16 to GS47)

GS17 Error Code

: :

GS46 Script No.

GS47 Error Code

GS48 Script Execute Pointer ➟12.1.3 ■2 (12) Script Execute Pointer (GS48)

GS49 to GS79 Script Execute No. ➟12.1.3 ■2 (13) Script Execute No. (GS49 to GS79)

GS80 Object Script Common Information ➟12.1.3 ■2 (14) Object Script Common Information 
(GS80)

GS81 Object Script Error Pointer ➟12.1.3 ■2 (15) Object Script Error Pointer (GS81)

GS82 Object Script User ID

➟12.1.3 ■2 (16) Object Script Error Data (GS82 to 
GS113)

GS83 Error Code

: :

GS112 Object Script User ID

GS113 Error Code

GS114 Object Script Execute Pointer ➟12.1.3 ■2 (17) Object Script Execute Pointer 
(GS114)

GS115 to GS145 Object Script Execute ID ➟12.1.3 ■2 (18) Object Script Execute No. (GS115 
to GS145)

GS146 to GS153 Use prohibited -

GS154 File operation function information ➟12.1.3 ■2 (19) File operation function information 
(GS154)

GS155
GS156

Use prohibited -

GS157 Latest Script Error Info Pointer ➟12.1.3 ■2 (20) Latest Script Error Info Pointer 
(GS157)

GS158 Latest Executed Script Pointer ➟12.1.3 ■2 (21) Latest Executed Script Pointer 
(GS158)

GS159 Latest Object Script Error Info Pointer ➟12.1.3 ■2 (22) Latest Object Script Error Info 
Pointer (GS159)

GS160 Latest Executed Object Script Pointer ➟12.1.3 ■2 (23) Latest Executed Object Script 
Pointer (GS160)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS161 to GS193 Use prohibited -

GS194
GS195

Ethernet Port 2 GOT IP Address
➟12.1.3 ■2 (24) Ethernet Port 2 GOT IP Address 

(GS194, GS195), Ethernet Port 1 GOT IP Address 
(GS198, GS199)

(Except 
GT2505-V and 
GT25HS-V)

GS196 to GS197 Use prohibited -

GS198
GS199

Ethernet Port 1 GOT IP Address
➟12.1.3 ■2 (24) Ethernet Port 2 GOT IP Address 

(GS194, GS195), Ethernet Port 1 GOT IP Address 
(GS198, GS199)

GS200 Gateway Common Information ➟12.1.3 ■2 (25) Gateway Common Information 
(GS200)

GS201 Mail Send Function Error Counter ➟12.1.3 ■2 (26) Mail Send Function Error Counter 
(GS201)

GS202 Mail Send Function Error Code ➟12.1.3 ■2 (27) Mail Send Function Error Code 
(GS202)

GS203 to GS205 Mail Send Function Error Occurrence Date And Time ➟12.1.3 ■2 (28) Mail Send Function Error 
Occurrence Date And Time (GS203 to GS205)

GS206 Mail Send Function Send Source ➟12.1.3 ■2 (29) Mail Send Function Send Source 
(GS206)

GS207 Use prohibited -

GS208 Number of Connected FTP Clients ➟12.1.3 ■2 (30) Number of Connected FTP Clients 
(GS208)

GS209 Use prohibited -

GS210 Server Function Error Counter ➟12.1.3 ■2 (31) Server Function Error Counter 
(GS210)

GS211 Server Function Error Code ➟12.1.3 ■2 (32) Server Function Error Code 
(GS211)

GS212 to GS214 Server Function Error Occurrence Date And Time ➟12.1.3 ■2 (33) Server Function Error Occurrence 
Date And Time (GS212 to GS214)

GS215
GS216

Server Function Error Client ➟12.1.3 ■2 (34) Server Function Error Client 
(GS215, GS216)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS217 to GS219 Use prohibited -

GS220 Client Function Error Counter ➟12.1.3 ■2 (35) Client Function Error Counter 
(GS220)

GS221 Client Function Error Code ➟12.1.3 ■2 (36) Client Function Error Code 
(GS221)

GS222 to GS224 Client Function Error Occurrence Date And Time ➟12.1.3 ■2 (37) Client Function Error Occurrence 
Date And Time (GS222 to GS224)

GS225
GS226

Client Function Error Server ➟12.1.3 ■2 (38) Client Function Error Counter 
(GS225, GS226)

GS227 to GS229 Use prohibited -

GS230 No. Of Faulty Stations ➟12.1.3 ■2 (39) No. Of Faulty Stations (GS230)

GS231 to GS238 Ethernet Faulty Station Information ➟12.1.3 ■2 (40) Ethernet Faulty Station Information 
(GS231 to GS238)

GS239 Use prohibited -

GS240 External Authentication Status Notification ➟12.1.3 ■2 (41) External Authentication Status 
Notification (GS240)

GS241 Insufficient Security Level Notification ➟12.1.3 ■2 (42) Insufficient Security Level 
Notification (GS241)

GS242 Incorrect Login ➟12.1.3 ■2 (43) Incorrect Login (GS242)

GS243 Object Direct Input Reception Notification ➟12.1.3 ■2 (44) Object Direct Input Reception 
Notification (GS243)

(Except 
GT25HS-V)

GS244 SoftGOT-GOT Link Status Control/Notification ➟12.1.3 ■2 (45) SoftGOT-GOT Link Status Control/
Notification (GS244)

GS245 to GS250 Use prohibited -

GS251 Drive Accessibility ➟12.1.3 ■2 (46) Drive Accessibility (GS251)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS252 Error Detection Common Information ➟12.1.3 ■2 (47) Error Detection Common 
Information (GS252)

GS253 Use prohibited -

GS254 Invalid Access from Ethernet Port 1, Invalid Access 
from Ethernet Port 2

➟12.1.3 ■2 (48) Invalid Access from Ethernet Port 
1, Invalid Access from Ethernet Port 2 (GS254)

GS255 Intensity Notification ➟12.1.3 ■2 (49) Intensity Notification (GS255)

GS256 FA Transparent Status ➟12.1.3 ■2 (50) FA Transparent Status (GS256)

GS257 Use prohibited -

GS258 Printer Status Information ➟12.1.3 ■2 (51) Printer Status Information (GS258)

(Except 
GT25HS-V)

GS259 Ethernet Printer Error Info ➟12.1.3 ■2 (52) Ethernet Printer Error Info (GS259)

GS260 Integer←→Real Number Conversion Status ➟12.1.3 ■2 (53) Integer←→Real Number 
Conversion Status (GS260)

GS261 Integer←→Real Number Conversion Error Code ➟12.1.3 ■2 (54) Integer←→Real Number 
Conversion Error Code (GS261)

GS262 System Alarm 
GOT Error Channel No.

➟12.1.3 ■2 (55) System Alarm GOT Error Channel 
No. (GS262)

GS263 System Alarm 
CPU Error Channel No.

➟12.1.3 ■2 (56) System Alarm CPU Error Channel 
No. (GS263)

GS264 System Alarm 
Network Error Channel No.

➟12.1.3 ■2 (57) System Alarm Network Error 
Channel No.(GS264)

GS265 SNTP Time Synchronization Setting Status ➟12.1.3 ■2 (58) SNTP Time Synchronization 
Setting Status (GS265)

GS266 to GS272 SNTP Time Query Result ➟12.1.3 ■2 (59) SNTP Time Query Result (GS266 
to GS272)

GS273
GS274

Use prohibited -

GS275 Monitoring Interval Timeout Count ➟12.1.3 ■2 (60) Monitoring Interval Timeout Count 
(GS275)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS276 Document Display Status Notification ➟12.1.3 ■2 (61) Document Display Status (GS276)

GS277 Notify Automatic Connection Status ➟12.1.3 ■2 (62) Notify Automatic Connection 
Status (GS277)

GS278 Report Page Number ➟12.1.3 ■2 (63) Report Page Number (GS278)

GS279 Standard SD Card Information ➟12.1.3 ■2 (64) Standard SD Card Information 
(GS279)

GS280 Faulty Monitor Station signal (CH1) ➟12.1.3 ■2 (65) Faulty Monitor Station signal (CH1 
to CH14) (GS280, GS300, GS320, GS340)

GS281 to GS288 Faulty Station Information (CH1)
➟12.1.3 ■2 (66) Faulty Station Information (CH1 to 

CH4) (GS281 to GS288, GS301 to GS308, 
GS321 to GS328, GS341 to GS348)

GS289 to GS298 Use prohibited -

GS299 Channel Observation Notification Information (CH1) ➟12.1.3 ■2 (67) Channel Observation Notification 
Information (GS299, GS319, GS339, GS359)

GS300 Faulty Monitor Station signal (CH2) ➟12.1.3 ■2 (65) Faulty Monitor Station signal (CH1 
to CH14) (GS280, GS300, GS320, GS340)

GS301 to GS308 Faulty Station Information (CH2)
➟12.1.3 ■2 (66) Faulty Station Information (CH1 to 

CH4) (GS281 to GS288, GS301 to GS308, 
GS321 to GS328, GS341 to GS348)

GS309 to GS318 Use prohibited -

GS319 Channel Observation Notification Information (CH2) ➟12.1.3 ■2 (67) Channel Observation Notification 
Information (GS299, GS319, GS339, GS359)

GS320 Faulty Monitor Station signal (CH3) ➟12.1.3 ■2 (65) Faulty Monitor Station signal (CH1 
to CH14) (GS280, GS300, GS320, GS340)

GS321 to GS328 Faulty Station Information (CH3)
➟12.1.3 ■2 (66) Faulty Station Information (CH1 to 

CH4) (GS281 to GS288, GS301 to GS308, 
GS321 to GS328, GS341 to GS348)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS329 to GS338 Use prohibited -

GS339 Channel Observation Notification Information (CH3) ➟12.1.3 ■2 (67) Channel Observation Notification 
Information (GS299, GS319, GS339, GS359)

GS340 Faulty Monitor Station signal (CH4) ➟12.1.3 ■2 (65) Faulty Monitor Station signal (CH1 
to CH14) (GS280, GS300, GS320, GS340)

GS341 to GS348 Faulty Station Information (CH4)
➟12.1.3 ■2 (66) Faulty Station Information (CH1 to 

CH4) (GS281 to GS288, GS301 to GS308, 
GS321 to GS328, GS341 to GS348)

GS349 to GS358 Use prohibited -

GS359 Channel Observation Notification Information (CH4) ➟12.1.3 ■2 (67) Channel Observation Notification 
Information (GS299, GS319, GS339, GS359)

GS360

CC-Link G4 Station No. (CH1) ➟12.1.3 ■2 (4) CC-Link G4 Station No.(CH1) (GS6)

GOT Multidrop Slave Station No. (CH1) ➟12.1.3 ■2 (5) GOT Multidrop Slave Station No. 
(CH1) (GS6)

GS361

CC-Link G4 Station No. (CH2) ➟12.1.3 ■2 (4) CC-Link G4 Station No.(CH1) (GS6)

GOT Multidrop Slave Station No. (CH2) ➟12.1.3 ■2 (5) GOT Multidrop Slave Station No. 
(CH1) (GS6)

GS362

CC-Link G4 Station No. (CH3) ➟12.1.3 ■2 (4) CC-Link G4 Station No.(CH1) (GS6)

GOT Multidrop Slave Station No. (CH3) ➟12.1.3 ■2 (5) GOT Multidrop Slave Station No. 
(CH1) (GS6)

GS363

CC-Link G4 Station No. (CH4) ➟12.1.3 ■2 (4) CC-Link G4 Station No.(CH1) (GS6)

GOT Multidrop Slave Station No. (CH4) ➟12.1.3 ■2 (5) GOT Multidrop Slave Station No. 
(CH1) (GS6)

GS364 to GS375 Use prohibited -

GS376
GS377

GOT Network No./Station No. Notification (CH1)

➟12.1.3 ■2 (68) GOT Network No./Station No. 
Notification (CH1 to CH4) (GS376 to GS383)

GS378
GS379

GOT Network No./Station No. Notification (CH2)

GS380
GS381

GOT Network No./Station No. Notification (CH3)

GS382
GS383

GOT Network No./Station No. Notification (CH4)

GS384 to GS639 Read device ➟■4 Read device list

GS640
GS641

Use prohibited -

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS642 Error Device Data Transfer ID ➟12.1.3 ■3 (1) Error Device Data Transfer ID 
(GS642)

GS643 Device Data Transfer Error Count ➟12.1.3 ■3 (2) Device Data Transfer Error Count 
(GS643)

GS644 Device Data Transfer Processing Time ➟12.1.3 ■3 (3) Device Data Transfer Processing 
Time (GS644)

GS645 Device Data Transfer ID ➟12.1.3 ■3 (4) Device Data Transfer ID (GS645)

GS646 Device Data Transfer Min. Processing Time ➟12.1.3 ■3 (5) Device Data Transfer Min. 
Processing Time (GS646)

GS647 Device Data Transfer ID (Min. Processing Time) ➟12.1.3 ■3 (6) Device Data Transfer ID (Min. 
Processing Time) (GS647)

GS648 Device Data Transfer Max. Processing Time ➟12.1.3 ■3 (7) Device Data Transfer Max. 
Processing Time (GS648)

GS649 Device Data Transfer ID (Max. Processing Time) ➟12.1.3 ■3 (8) Device Data Transfer ID (Max. 
Processing Time) (GS649)

GS650 to GS653 Present Time ➟12.1.3 ■3 (9) Present Time (GS650 to GS635)

GS654 Touch Status External Notification (X-coordinate) ➟12.1.3 ■3 (10) Touch Status External Notification 
(X-coordinate) (GS654)

GS655 Touch Status External Notification (Y-coordinate) ➟12.1.3 ■3 (11) Touch Status External Notification 
(Y-coordinate) (GS655)

GS656 Touch Status External Notification (Touch Status) ➟12.1.3 ■3 (12) Touch Status External Notification 
(Touch Status) (GS656)

GS657 Trigger Backup Processing Setting No. Notification 
signal

➟12.1.3 ■3 (13) Trigger Backup Processing Setting 
No. Notification (GS657)

GS658 to GS665 Extended External Input Status Notification signal ➟12.1.3 ■3 (14) Extended External Input Status 
Notification signal (GS658 to GS665)

(Except 
GT2505-V and 
GT25HS-V)

GS666 to GS667 Use prohibited -

GS668 Sound Status Information ➟12.1.3 ■3 (15) Sound Status Information (GS668)

(Except 
GT2505-V and 
GT25HS-V)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GS669 Sound File Number During Play ➟12.1.3 ■3 (16) Sound File Number During Play 
(GS669)

(Except 
GT2505-V and 
GT25HS-V)

GS670 Number of Trigger Buffer Data ➟12.1.3 ■3 (17) Number of Trigger Buffer Data 
(GS670)

GS671 Trigger Buffer Overflow Count ➟12.1.3 ■3 (18) Trigger Buffer Overflow Count 
(GS671)

GS672 to GS675 Trigger Buffer Overflow Flag per Job ➟12.1.3 ■3 (19) Trigger Buffer Overflow Flag per 
Job (GS672 to GS675)

GS676 to GS692 Use prohibited -

GS693 Notify Number of Hard Copy Output Screens signal ➟12.1.3 ■3 (20) Notify Number of Hard Copy Output 
Screens signal (GS693)

GS694 Object Position upon Cursor Display (X Coordinate) ➟12.1.3 ■3 (21) Object Position upon Cursor 
Display (GS694 and GS695)GS695 Object Position upon Cursor Display (Y Coordinate)

GS696 Expanded Base Screen Position (X Coordinate) ➟12.1.3 ■3 (22) Expanded Base Screen Position 
(GS696 and GS697)GS697 Expanded Base Screen Position (Y Coordinate)

GS698 to GS979 Use prohibited -

GS980 Touch Position Color Acquisition Complete signal ➟12.1.3 ■3 (23) Touch Position Color Acquisition 
Complete signal (GS980)

GS981 to GS983 Touch Position Color ➟12.1.3 ■3 (24) Touch Position Color (GS981 to 
GS983)

GS984 Authorization Guarantee Status Notification signal ➟12.1.3 ■3 (25) Authorization Guarantee Status 
Notification signal (GS984)

GS985
GS986

Use prohibited -

GS987 Executing File Transfer ID Notification ➟12.1.3 ■3 (26) Executing File Transfer ID 
Notification (GS987)

GS988 Communicating FTP Server ID Notification ➟12.1.3 ■3 (27) Communicating FTP Server ID 
Notification (GS988)

GS989 File Transfer Error No. ➟12.1.3 ■3 (28) File Transfer Error No. (GS989)

GS990 File Transfer Status ➟12.1.3 ■3 (29) File Transfer Status (GS990)

GS991 Number of Transfer Target Files ➟12.1.3 ■3 (30) Number of Transfer Target Files 
(GS991)

GS992 Number of Transferred Files ➟12.1.3 ■3 (31) Number of Transferred Files 
(GS992)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
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GT21 GS21GS25
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GS993 to GS1009 Use prohibited -

GS1010 Recipe Status ➟12.1.3 ■3 (32) Recipe Status(GS1010)

GS1011 Recipe Special Control Result ➟12.1.3 ■3 (33) Recipe Special Control Result 
(GS1011)

GS1012 Recipe Special Control No. ➟12.1.3 ■3 (34) Recipe Special Control No. 
(GS1012)

GS1013 Recipe Display (Record List) Target Recipe No. ➟12.1.3 ■3 (35) Recipe Display (Record List) 
Target Recipe No. (GS1013)

GS1014 Recipe Display (Record List) Selected Record No. ➟12.1.3 ■3 (36) Recipe Display (Record List) 
Selected Record No. (GS1014)

GS1015 Recipe Display (Record List) Target Record No. ➟12.1.3 ■3 (37) Recipe Display (Record List) 
Target Record No. (GS1015)

GS1016 Recipe Display (Record List) Record Manipulation 
Result

➟12.1.3 ■3 (38) Recipe Display (Record List) 
Record Manipulation Result (GS1016)

GS1017 to GS1021 Use prohibited -

GS1022 Video File Maintenance Information ➟12.1.3 ■3 (39) Video File Maintenance 
Information (GS1022)

GS1023 Use prohibited -

GS1024 USB Drive Common Information ➟12.1.3 ■3 (40) USB Drive Common Information 
(GS1024)

(Only available 
to GT2107-W 
for GT21)

GS1025 RGB Signal Input Status Notification ➟12.1.3 ■3 (41) RGB Signal Input Status 
Notification (GS1025)

GS1026 RGB Signal Resolution (Horizontal) ➟12.1.3 ■3 (42) RGB Signal Resolution (Horizontal) 
(GS1026)

GS1027 RGB Signal Resolution (Vertical) ➟12.1.3 ■3 (43) RGB Signal Resolution (Vertical) 
(GS1027)

GS1028 RGB Signal Refresh Rate ➟12.1.3 ■3 (44) RGB Signal Refresh Rate 
(GS1028)

GS1029 Use prohibited -

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
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GT27 GT25 GT23
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GS1030 Video/RGB Display Object Status (CH1) ➟12.1.3 ■3 (45) Video/RGB Display Object Status 
(CH1 to CH2) (GS1030, GS1035)

GS1031 Video/RGB Display Object Horizontal Resolution 
(CH1)

➟12.1.3 ■3 (46) Video/RGB Display Object 
Horizontal Resolution (CH1 to CH2) (GS1031, 
GS1036)

GS1032 Video/RGB Display Object Vertical Resolution (CH1) ➟12.1.3 ■3 (47) Video/RGB Display Object Vertical 
Resolution (CH1 to CH2) (GS1032, GS1037)

GS1033 Video/RGB Display Object Refresh Rate (CH1) ➟12.1.3 ■3 (48) Video/RGB Display Object Refresh 
Rate (CH1 to CH2) (GS1033, GS1038)

GS1034 Use prohibited -

GS1035 Video/RGB Display Object Status (CH2) ➟12.1.3 ■3 (45) Video/RGB Display Object Status 
(CH1 to CH2) (GS1030, GS1035)

GS1036 Video/RGB Display Object Horizontal Resolution 
(CH2)

➟12.1.3 ■3 (46) Video/RGB Display Object 
Horizontal Resolution (CH1 to CH2) (GS1031, 
GS1036)

GS1037 Video/RGB Display Object Vertical Resolution (CH2) ➟12.1.3 ■3 (47) Video/RGB Display Object Vertical 
Resolution (CH1 to CH2) (GS1032, GS1037)

GS1038 Video/RGB Display Object Refresh Rate (CH2) ➟12.1.3 ■3 (48) Video/RGB Display Object Refresh 
Rate (CH1 to CH2) (GS1033, GS1038)

GS1039 Use prohibited -

GS1040 Wireless Processing Security Information ➟12.1.3 ■3 (49) Wireless Processing Security 
Information (GS1040)

(Except 
GT2505-V and 
GT25HS-V)

GS1041 to GS1042 Use prohibited -

GS1043 to GS1044 Ethernet Port 1 Subnet Mask Notification
➟12.1.3 ■3 (50) Ethernet Port 1 Subnet Mask 

Notification (GS1043, GS1044), Ethernet Port 2 
Subnet Mask Notification (GS1045, GS1046)

GS1045 to GS1046 Ethernet Port 2 Subnet Mask Notification
➟12.1.3 ■3 (50) Ethernet Port 1 Subnet Mask 

Notification (GS1043, GS1044), Ethernet Port 2 
Subnet Mask Notification (GS1045, GS1046)

GS1047 to GS1048 Wireless LAN Port Subnet Mask Notification ➟12.1.3 ■3 (51) Wireless LAN Port Subnet Mask 
Notification (GS1047 to GS1048)

GS1049 to GS1050 Default Gateway Notification ➟12.1.3 ■3 (52) Default Gateway Notification 
(GS1049 to GS1050)

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23
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SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23
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GS1051 to GS1059 Use prohibited -

GS1060 Wireless LAN Status Notification ➟12.1.3 ■3 (53) Wireless LAN Status Notification 
(GS1060)

(Except 
GT2505-V and 
GT25HS-V)

GS1061 Reception Field Intensity Notification ➟12.1.3 ■3 (54) Reception Field Intensity 
Notification (GS1061)

GS1062 to GS1066 Use prohibited -

GS1067 to GS1069 Access Point MAC Address Notification ➟12.1.3 ■3 (55) Access Point MAC Address 
Notification(GS1067 to GS1069)

(Except 
GT2505-V and 
GT25HS-V)

GS1070 to GS1071 Use prohibited -

GS1072 Number of Connected Stations ➟12.1.3 ■3 (56) Number of Connected Stations 
(GS1072)

(Except 
GT2505-V and 
GT25HS-V)

GS1073 to GS1079 Use prohibited -

GS1080 Label Name Resolution Status (Common)

➟12.1.3 ■3 (57) Label Name Resolution Status 
(Common, CH1 to CH4) (GS1080, GS1081 to 
GS1084)

GS1081 Label Name Resolution Status (CH1)

GS1082 Label Name Resolution Status (CH2)

GS1083 Label Name Resolution Status (CH3)

GS1084 Label Name Resolution Status (CH4)

GS1085 to GS1109 Use prohibited -

Device Function Reference Supported 
models
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SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
12. APPENDICES
12.1 GOT Internal Device

12 - 17



GS1110 to GS1111 HMS Communication Module Version ➟12.1.3 ■3 (58) HMS Communication Module 
Version (GS1110 to GS1111)

(Except 
GT2505-V and 
GT25HS-V)

GS1112 to GS1113 HMS Communication Module Error Details ➟12.1.3 ■3 (59) HMS Communication Module Error 
Details (GS1112 to GS1113)

GS1114 CC-Link IE TSN Module Communication Test Status ➟12.1.3 ■3 (60) CC-Link IE TSN Module 
Communication Test Status (GS1114)

GS1115 CC-Link IE TSN Module Communication Test Error ➟12.1.3 ■3 (61) CC-Link IE TSN Module 
Communication Test Error (GS1115)

GS1116 to GS1219 Use prohibited -

GS1220 Special Function Switch Special Control ➟12.1.3 ■3 (62) Special Function Switch Special 
Control (GS1220)

GS1221 iQSS Utility Special Control Error Sensor Device No. ➟12.1.3 ■3 (63) iQSS Utility Special Control Error 
Sensor Device No. (GS1221)

GS1222 to GS1229 Use prohibited -

GS1230 VNC Server Operation Status Notification ➟12.1.3 ■3 (64) VNC Server Operation Status 
Notification (GS1230)

(Only available 
to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

GS1231
GS1232

VNC Client IP Address ➟12.1.3 ■3 (65) Communicating VNC Client 
Information Notification (GS1231, GS1232)

GS1233 VNC Server Authorization Guarantee Status 
Notification

➟12.1.3 ■3 (66) VNC Server Authorization 
Guarantee Status Notification (GS1233)

GS1234 to GS1240 Use prohibited -

GS1241 Insufficient Security Level Notification ➟12.1.3 ■3 (67) Insufficient Security Level 
Notification (GS1241)

GS1242 to GS1270 Use prohibited ➟12.1.3 ■3 (67) Insufficient Security Level 
Notification (GS1241)

GS1271 Report Output Status: Print Date/Time (Year) 
(GS1271)

➟12.1.3 ■3 (68) Report Output Status: Print Date/
Time (Year) (GS1271)

GS1272 Report Output Status: Print Date/Time (Month) 
(GS1272)

➟12.1.3 ■3 (69) Report Output Status: Print Date/
Time (Month) (GS1272)

Device Function Reference Supported 
models
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GS1273 Report Output Status: Print Date/Time (Day) 
(GS1273)

➟12.1.3 ■3 (70) Report Output Status: Print Date/
Time (Day) (GS1273)

GS1274 Use prohibited -

GS1275 Report Output Status: Print Date/Time (Hour) 
(GS1275)

➟12.1.3 ■3 (71) Report Output Status: Print Date/
Time (Hour) (GS1275)

GS1276 Report Output Status: Print Date/Time (Minute) 
(GS1276)

➟12.1.3 ■3 (72) Report Output Status: Print Date/
Time (Minute) (GS1276)

GS1277 Report Output Status: Print Date/Time (Second) 
(GS1277)

➟12.1.3 ■3 (73) Report Output Status: Print Date/
Time (Second) (GS1277)

GS1278 Report Output Status: Total Number of Pages 
(GS1278)

➟12.1.3 ■3 (74) Report Output Status: Total 
Number of Pages (GS1278)

GS1279 Report Output Status: Operator Name (GS1279) ➟12.1.3 ■3 (75) Report Output Status: Operator 
Name (GS1279)

GS1280 Faulty Monitor Station signal (CC-Link IE TSN) ➟12.1.3 ■3 (76) Faulty Monitor Station signal (CC-
Link IE TSN) (GS1280)

GS1281 to GS1288 Faulty Station Information (CC-Link IE TSN) ➟12.1.3 ■3 (77) Faulty Station Information (CC-Link 
IE TSN) (GS1281 to GS1288)

GS1289 to GS1296 Use prohibited -

GS1297 CC-Link IE TSN Connection Status ➟12.1.3 ■3 (78) CC-Link IE TSN Connection Status 
(GS1297)

GS1298 to GS1399 Use prohibited -

GS1400 Number of Connected GOT Mobile Function Clients ➟12.1.3 ■3 (79) Number of Connected GOT Mobile 
Function Clients (GS1400)

GS1401 GOT Mobile Function Connection Status ➟12.1.3 ■3 (80) GOT Mobile Function Connection 
Status (GS1401)

Device Function Reference Supported 
models

GT27 GT25 GT23
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GS1402 to GS1459 Use prohibited -

GS1460 Authorization Status Information ➟12.1.3 ■3 (81) Authorization Status Information 
(GS1460)

GS1461 to GS1462 Master GOT IP Address ➟12.1.3 ■3 (82) Master GOT IP Address (GS1461 
to GS1462)

GS1463 Time Elapsed from Authorization Acquisition ➟12.1.3 ■3 (83) Time Elapsed from Authorization 
Acquisition (GS1463)

GS1464 Authorization Guarantee Time ➟12.1.3 ■3 (84) Authorization Guarantee Time 
(GS1464)

GS1465 Authorization Management Information ➟12.1.3 ■3 (85) Authorization Management 
Information (GS1465)

GS1466 to GS1467 Authorized Equipment IP Address ➟12.1.3 ■3 (86) Authorized Equipment IP Address 
(GS1466 to GS1467)

GS1468 Authorized Equipment Type ➟12.1.3 ■3 (87) Authorized Equipment Type 
(GS1468)

GS1469 Authorized Equipment ID Information ➟12.1.3 ■3 (88) Authorized Equipment ID 
Information (GS1469)

GS1470 Authorization Use Time ➟12.1.3 ■3 (89) Authorization Use Time (GS1470)

GS1471 to GS1499 Use prohibited -

GS1500 GOT Ethernet Setting Change Status ➟12.1.3 ■3 (90) GOT Ethernet Setting Change 
Status (GS1500)

Device Function Reference Supported 
models
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■2 Write device (GS0 to GS383)

(1) Common Information1 (GS0)
• b0: Repeats turning on and off for every communication cycle (For channel No. 1) *1

• b1: Turns on when the base or window screen is switched and remains on until a cycle of the on-screen setting 
processing is complete.
(This applies to the station No. switching, security level change or language switching.)
It is used to check (debug) the screen switch setting processing.

• b2: Turns on when the base or window screen is switched and remains on until a cycle of the trigger action processing 
for the project and screen display is complete.
(This applies to the station No. switching, security level change or language switching.)
It is used to activate the trigger action only once in switching the screen.

• b3: Turns on while the initial screen is displayed at power-on.
It turns off when the base screen is switched over.

• b4: Always on
• b5: Always off
• b6 to b7: Use prohibited

• b8: Repeats turning on and off for every communication cycle (For channel No. 2) *1

• b9: Repeats turning on and off for every communication cycle (For channel No. 3) *1

• b10: Repeats turning on and off for every communication cycle (For channel No. 4) *1

• b11 to b14: Use prohibited
• b15: Turns on in the screen gesture mode.

*1 One cycle is the elapsed time for the GOT to read the objects on the current screen display and the data set in the common 
settings.

Actions of b4 and b5 in the Common Information 1 (GS0)
Actions of b4 and b5 in the Common Information 1 (GS0) are the Always ON (GB40) and the Always OFF (GB41) 
respectively.

(2) Base Screen Information (GS1)
• b0: Repeats turning on and off for every communication cycle while the base screen is displayed. (For channel No. 1)
• b1: Turns on when the base screen is switched and remains on until a cycle of the on-screen setting processing is 

complete.
(This applies to the station No. switching, security level change or language switching.)
It is used to check (debug) the screen switch setting processing.

• b2: Turns on when the base screen is switched and remains on until a cycle of the on-screen setting processing is 
complete. (This applies to the station No. switching, security level change or language switching.)
It is used to activate the trigger action only once in switching the screen.

• b3 to b7: Use prohibited
• b8: Repeats turning on and off for every communication cycle while the base screen is displayed. (For channel No. 2)
• b9: Repeats turning on and off for every communication cycle while the base screen is displayed. (For channel No. 3)
• b10: Repeats turning on and off for every communication cycle while the base screen is displayed. (For channel No. 

4)
• b11 to b15: Use prohibited

GS1501 to GS1791 Use prohibited -

GS1792 to GS2047 Read device ➟■4 Read device list

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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(3) GOT ID No. (GS3)
Notifies the GOT ID number.
The notified GOT ID numbers range from 0 to 32767.
Notifies 0 when no GOT ID number is used.

(4) CC-Link G4 Station No.(CH1) (GS6)
For the CC-Link connection (via G4), the station number of the connected AJ65BT-G4-S3 or AJ65BT-R2N is stored when 
the GOT is powered on.
When the multi-channel function is used, the station number of channel No. 1 is stored.
The station numbers of channel No. 2 to 4 are stored to GS361 to GS363.

(5) GOT Multidrop Slave Station No. (CH1) (GS6)
For the multidrop connection, the station number of the connected GOT is stored when the GOT is powered on.
When the multi-channel function is used, the station number of channel No. 1 is stored.
The station numbers of channel No. 2 to 4 are stored to GS361 to GS363.

(6) 1 Second Binary Counter (GS7)
Starts counting every second immediately after the power is switched on.
When a value is written by a user, counting starts from the written value.
It is used to check how long the time has elapsed from specific timing (operation and others).
Data type: Unsigned binary
Counting range: 0 to 65535
When counting reaches the maximum value, a new counting starts from 0.

(7) Scan Time of Monitor (GS8)
Stores the time (ms) of a complete processing cycle set on the display screen as binary data.
Data will be updated when all of the processing set on the display screen is complete.
An error of plus or minus 10 ms may be produced depending on the processing settings.
Also, it does not apply to the objects that have not been processed by the security function.
It is useful for load checking (debug) of the monitor processing.

(8) Scan Counter of Monitor (GS10)
Counts up the number of cycles every time the processing cycle set on the display screen is complete.
It is used to check (debug) the number of scan of monitor.
Data type: Unsigned binary
Counting range: 0 to 65535
When counting reaches the maximum value, a new counting starts from 0.

(9) Script Common Information (GS14)
The following script types are supported: project script, screen script, and script part.
Stores information of error occurrence.

• b0: Turns on in error occurrence
• b1 to b6: Use prohibited
• b7: Turns on in BCD error occurrence
• b8: Turns on in zero division error occurrence
• b9 to b11: Use prohibited
• b12: Turns on in communication error occurrence (including access to the device out of range)
• b13 to b15: Use prohibited

(10)Script Error Pointer (GS15)
The following script types are supported: project script and screen script.
Stores a number showing the start device number of the devices where the latest error record is stored.
Each error record is stored in two Script Error Data devices (GS16 to GS47).
The value at GS15 is changed as shown below each time an error occurs.
-1 → 16 → 18 → ··· → 46 (The value is back to 16 and changes repeatedly.)
The following shows the relationship between the value of GS15 and the storage location of the latest error record.

• When GS15 stores 16, the latest error record is stored in GS16 and GS17.
• When GS15 stores 46, the latest error record is stored in GS46 and GS47.
12 - 22 12. APPENDICES
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(11)Script Error Data (GS16 to GS47)
The following script types are supported: project script and screen script.
Store the script numbers and error codes for the error-generated scripts.
Two word devices are used for one error.
If the number of errors is 17 or more, the error records are overwritten starting from the oldest one.

(12)Script Execute Pointer (GS48)
The following script types are supported: project script and screen script.
Stores the device number of the device where the latest script execution number is stored.
Each script execution number is stored in one Script Execute No. device (GS49 to GS79).
The value at GS48 changes as shown below each time the project script and the screen script are executed.
-1 → 49 → 50 → ··· → 79 (The value is back to 49 and changes repeatedly.)
The following shows the relationship between the value of GS48 and the storage location of the latest script execution 
number.

• When GS48 stores 49, the latest script execution number is stored in GS49.
• When GS48 stores 79, the latest script execution number is stored in GS79.

(13)Script Execute No. (GS49 to GS79)
The following script types are supported: project script and screen script.
Store the script numbers of the executed scripts.
One word device is used for one script.
If the number of the executed scripts is 32 or more, the script execution records are overwritten starting from the oldest 
one.

(14)Object Script Common Information (GS80)
Stores information of error occurrence.

• b0: Turns on in error occurrence
• b1 to b6: Use prohibited
• b7: Turns on in BCD error occurrence
• b8: Turns on in zero division error occurrence
• b9 to b11: Use prohibited
• b12: Turns on in communication error occurrence (including access to the device out of range)
• b13 to b15: Use prohibited

(15)Object Script Error Pointer (GS81)
Stores a number showing the start device number of the devices where the latest error record is stored.
Each error record is stored in two Object Script Error Data devices (GS82 to GS113).
The value at GS81 changes as shown below each time an error occurs.
-1 → 82 → 84 → ··· → 112 (The value is back to 16 and changes repeatedly.)
The following shows the relationship between the value of GS81 and the storage location of the error code of the latest 
error.

• When GS81 stores 82, the latest error record is stored in GS82 and GS83.
• When GS81 stores 112, the latest error record is stored in GS112 and GS113.

(16)Object Script Error Data (GS82 to GS113)
Store the script user ID numbers and error codes for the error-generated object scripts.
Two word devices are used for one error.
If the number of errors is 17 or more, the error records are overwritten starting from the oldest one.

(17)Object Script Execute Pointer (GS114)
Stores the device number of the device where the latest script execution number is stored.
Each script execution number is stored in one Object Script Execute No. device (GS115 to GS145).
The value at GS114 changes as shown below each time an object script is executed.
-1 → 115 → 116 → ··· → 145 (The value is back to 115 and changes repeatedly.)
The following shows the relationship between the value of GS114 and the storage location of the latest script execution 
number.

• When GS114 stores 115, the latest script execution number is stored in GS115.
• When GS114 stores 145, the latest script execution number is stored in GS145.
12. APPENDICES
12.1 GOT Internal Device

12 - 23



(18)Object Script Execute No. (GS115 to GS145)
Store the script numbers of the executed scripts.
One word device is used for one script.
If the number of the executed scripts is 32 or more, the script execution records are overwritten starting from the oldest 
one.

(19)File operation function information (GS154)
The following script types are supported: project script and screen script.
Notifies the execution status of the file operation function.

• b0: Turns on during the executing for a file operation function.
Turns off when the file operation function is completed.

• b1 to b14: Use prohibited
• b15: Turns on when an error occurs with a file operation function.

The bit turns off when the next file operation function is completed normally.
This bit does not turn off even if the Script Error Clear signal (GS384.b0) is turned on.

(20)Latest Script Error Info Pointer (GS157)
The following script types are supported: project script, screen script, and script part.
Stores a number showing the devices where the latest error record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest error record by using the following expression.

• GS392 + (GS157 × 8)

(21)Latest Executed Script Pointer (GS158)
The following script types are supported: project script, screen script, and script part.
Stores a number showing the devices where the latest script execution record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest script execution record by using the following 
expression.

• GS396 + (GS158 × 8)

(22)Latest Object Script Error Info Pointer (GS159)
Stores a number showing the area where the latest object script error record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest error record by using the following expression.

• GS432 + (GS159 × 8)

(23)Latest Executed Object Script Pointer (GS160)
Stores a number showing the area where the latest object script execution record is stored.
Data type: Signed binary
Initial value: -1
Calculate the start device number of the devices storing the latest script execution record by using the following 
expression.

• GS436 + (GS160 × 8)

(24)Ethernet Port 2 GOT IP Address (GS194, GS195), Ethernet Port 1 GOT IP Address (GS198, GS199)
Stores the GOT IP address that is specified for the GOT Ethernet interface in hexadecimal.
The following shows the IP address to be stored to each device.

Example) When the GOT IP address for the Ethernet standard port of GT27 is 192.168.3.18 (decimal)

GOT GOT IP address Destination device

GT27, GT25-S, 
GT25-V (excluding 
GT2505-V)

GOT IP address for the Ethernet standard port GS198, GS199

GOT IP address for the Ethernet extended port GS194, GS195

GT25-W, GS25
GOT IP address for Ethernet standard port 1 GS198, GS199

GOT IP address for Ethernet standard port 2 GS194, GS195

GT2505-V, 
GT25HS-V, GT23, 
GT21, GS21

GOT IP address for the Ethernet standard port GS198, GS199
12 - 24 12. APPENDICES
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(25)Gateway Common Information (GS200)
Notifies the common information of the gateway function
GT21 and GS21 support b1 and b2.

• b0: Turns on while the mail send function is ready.
• b1: Turns on while the FTP server function is ready.
• b2: Turns on when an FTP client is logged in.
• b3: ON while the server function is ready.
• b4: ON while the client function is ready.
• b5 to b10: Use prohibited
• b11: Turns on when an error occurs in the mail send function.
• b12 to b13: Use prohibited
• b14: Turns on when an error occurs in the server function.
• b15: Turns on when an error occurs in the client function.

(26)Mail Send Function Error Counter (GS201)
Counts the number of the errors that have occurred in the mail send function.

(27)Mail Send Function Error Code (GS202)
Stores the codes of the errors that have occurred in the mail send function.
For the error codes to be stored, refer to the following.

➟10.15.8 ■3 Error code and error message of the mail send function

(28)Mail Send Function Error Occurrence Date And Time (GS203 to GS205)
Stores the day and the time of the error occurrence with BCD code.
Example) When the error occurrence date is 15:30:20 May 15, 2013

(29)Mail Send Function Send Source (GS206)
Notifies the type of the function that has caused the error in the mail sending process.

• 0: No error
• 1: User alarm observation
• 2 or more: Use prohibited

(30)Number of Connected FTP Clients (GS208)
Notifies the number of the clients connected to the FTP server.
Clients are counted when the OPEN command (an FTP command) is executed.

(31)Server Function Error Counter (GS210)
Counts the number of the errors that have occurred in the server function.

(32)Server Function Error Code (GS211)
Stores the codes of the errors that have occurred in the server function.
The following shows the list of the error code to be stored.

GS198

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS199

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GOT IP address: C0. A8. 03. 12 (Hexadecimal)

GS203

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS204

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error occurrence date: 2013 / 5 / 15   15:30:20 (Binary Coded Decimal)

GS205

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error code Details of error and cause Corrective action

490 A script was used for monitoring the 
gate device that executed the script.

• Change the monitor destination GOT specified in the script to another GOT.
• Monitor the PLC devices directly without using the script.

491 A station that does not exist was 
accessed.

Check the network number, the PLC station number, and the Ethernet settings of 
the monitor destination.
12. APPENDICES
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(33)Server Function Error Occurrence Date And Time (GS212 to GS214)
Stores the day and the time of the error occurrence with BCD code.
Example) When the error occurrence date is 15:30:20 May 15, 2013

(34)Server Function Error Client (GS215, GS216)
Stores the IP address of the GOT (client) where the error occurred in hexadecimal.
Example) When the GOT IP address is 192.168.3.18 (decimal)

(35)Client Function Error Counter (GS220)
Counts the number of the errors that have occurred in the client function.

(36)Client Function Error Code (GS221)
Stores the codes of the errors that have occurred in the client function.
The following shows the list of the error code to be stored.

(37)Client Function Error Occurrence Date And Time (GS222 to GS224)
Stores the day and the time of the error occurrence with BCD code.
Example) When the error occurrence date is 15:30:20 May 15, 2013

(38)Client Function Error Counter (GS225, GS226)
Stores the IP address of the GOT (server) where the error occurred in hexadecimal.
Example) When the GOT IP address is 192.168.3.18 (decimal)

492 A communication timeout error has 
occurred.

• Specify a longer communication timeout period.

➟5.5.1 ■4 [Controller Setting]
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)
• Check for cable disconnection, and check the module mounting status.

493 A communication error has occurred.
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)
• Check for cable disconnection, and check the module mounting status.

Error code Details of error and cause Corrective action

GS212

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS213

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS214

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error occurrence date: 2013 / 5 / 15   15:30:20 (Binary Coded Decimal)

GS216

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS215

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GOT IP address: C0. A8. 03. 12 (Hexadecimal)

Error code Details of error and cause Corrective action

490 A script was used for monitoring the 
gate device that executed the script.

• Change the monitor destination GOT specified in the script to another GOT.
• Monitor the PLC devices directly without using the script.

491 A station that does not exist was 
accessed.

Check the network number, the PLC station number, and the Ethernet settings of 
the monitor destination.

492 A communication timeout error has 
occurred.

• Specify a longer communication timeout period.

➟5.5.1 ■4 [Controller Setting]
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)
• Check for cable disconnection, and check the module mounting status.

493 A communication error has occurred.
• Check the network. (Check if firewall exists, execute Ping, or take other actions.)
• Check for cable disconnection, and check the module mounting status.

GS212

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS213

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS214

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error occurrence date: 2013 / 5 / 15   15:30:20 (Binary Coded Decimal)
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(39)No. Of Faulty Stations (GS230)
Stores the number of stations where CPU error was detected.
The station where error occurs can be checked with GS231 to GS238.

➟(40) Ethernet Faulty Station Information (GS231 to GS238)
When the redundant setting is configured, these GS devices do not operate.

• b0 to b7: Stores the number of faulty stations.
• b8 to b15: Use prohibited

Monitoring GS230 by numerical display
To monitor GS230 by numerical display and others, perform mask processing using data operation function as 
follows.
➟6.5.5 ■4 Setting data operations

Example) Setting of numerical display (the [Operation/Script] tab)

(40)Ethernet Faulty Station Information (GS231 to GS238)
When the Ethernet connection is used, the bit corresponding to the station with a communication error turns on.
When the multi-channel connection is used, the Ethernet-connected controller with the smallest channel number is 
monitored.
To monitor the faulty station information of multiple channels, use the following GOT special registers (GS).

➟(66) Faulty Station Information (CH1 to CH4) (GS281 to GS288, GS301 to GS308, GS321 to GS328, 
GS341 to GS348)

0: No error
1: Error
When the Ethernet module has restored from the error, the bit turns off.

GS226

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS225

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GOT IP address: C0. A8. 03. 12 (Hexadecimal)

Make setting for mask processing of the upper 8 bits 
(b15 to b8) of GS230 in the the numerical display.
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The following shows the communication drivers that support the devices.
○ : Supported, - : Not supported

Device
Ethernet setting No.

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS231 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

GS232 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17

GS233 48 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33

GS234 64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

GS235 80 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65

GS236 96 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81

GS237 112 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97

GS238 128 127 126 125 124 123 122 121 120 119 118 117 116 115 114 113

Communication driver

Supported/
Unsupported

Communication driver

Supported/
Unsupported

Host 
station

Other 
stations

Host 
station

Other 
stations

[Bus Q] - - [Panasonic MINAS A5] - -

[Bus A/QnA] - - [Muratec MPC] - -

[Serial(MELSEC)] - - [Computer] - -

[AJ71QC24, MELDAS C6*] - - [MELSERVO-J4,J3,J2S/M,JE] - -

[AJ71C24/UC24] - - [FREQROL 500/700/800,SENSORLESS SERVO] - -

[CC-Link(G4)] - - [FREQROL 800] - -

[MELSECNET/H] - - [FREQROL(Batch monitor)] - -

[CC-Link Ver.2(ID)] - - [OMRON THERMAC/INPANEL NEO] - -

[CC-Link IE Controller Network] - - [OMRON Digital Temperature Controller] - -

[CC-Link IE Field Network] - - [azbil SDC/DMC] - -

[CC-Link IE TSN] - - [azbil DMC50] - -

[MELSEC-FX] - - [RKC SR Mini HG(MODBUS)] - -

[MELSEC-WS] - - [FUJI Temperature Controller/Digital Controller] - -

[MEI Nexgenie] - - [YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced] - -

[Multidrop(Slave)] - - [Shinko Technos Controller] - -

[OMRON SYSMAC] - - [CHINO MODBUS device] - -

[YASKAWA GL] - - [MODBUS/RTU Master] - -

[YASKAWA CP9200 (H)] - - [MODBUS/RTU Slave] - -

[YASKAWA CP9300MS (MC compatible)] - - [Ethernet(MITSUBISHI ELECTRIC), Gateway] ○ ○

[YASKAWA MP2000/MP900/CP9200SH] - - [Ethernet(FX), Gateway] ○ ○

[AB SLC500, AB 1:N] - - [Ethernet(FREQROL), Gateway] ○ ○

[AB MicroLogix] - - [Ethernet(FREQROL(Batch monitor)), Gateway] ○ ○

[AB MicroLogix(Extended)] - - [Ethernet(YASKAWA), Gateway] ○ ○

[AB Control/CompactLogix] - - [Ethernet(YASKAWA MP3000), Gateway] ○ ○

GS231.b0
GS231.b1
GS231.b2
GS231.b3
GS231.b4
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(41)External Authentication Status Notification (GS240)
• b0: Turns on when the authentication by an external authentication device succeeds.

Turns off when the login screen or operator re-authentication screen is displayed regardless of the authentication 
method.

• b1: Turns on when the authentication by an external authentication device fails.
Turns off when the login screen or operator re-authentication screen is displayed regardless of the authentication 
method.

• b2 to b12: Use prohibited
• b13: Turns on while the login screen or operator re-authentication screen is displayed.
• b14: Turns on while the login screen for the authentication by an external authentication device is displayed.
• b15: Turns on while the external authentication ID input key window is displayed.

Notifying the authentication mode by b13 and b14
The status of the Operator Authentication Reception signal and the External Authentication Reception signal 
notifies the user of the authentication mode currently being accepted.

This notifies the user of switching to the auxiliary authentication.

[SHARP JW] - - [Ethernet(YASKAWA High Speed Ethernet Server), 
Gateway] ○ ○

[TOSHIBA PROSEC T/V] - - [Ethernet(YOKOGAWA), Gateway] ○ ○

[HITACHI IES HIDIC H] - - [Ethernet(AB), Gateway] ○ ○

[HITACHI IES HIDIC H(Protocol2)] - - [Ethernet(AB MicroLogix), Gateway] ○ ○

[Panasonic MEWNET-FP] - - [Ethernet(AB Tag), Gateway] ○ ○

[Panasonic MEWTOCOL-7] - - [Ethernet(OMRON), Gateway] ○ ○

[SIEMENS S7-200] - - [Ethernet(OMRON NJ/NX), Gateway] ○ ○

[SIEMENS S7-300/400] - - [Ethernet(TOSHIBA nv), Gateway] ○ ○

[YOKOGAWA FA500/FA-M3/STARDOM] - - [Ethernet(HITACHI IES), Gateway] ○ ○

[Serial(KEYENCE)] - - [Ethernet(HITACHI), Gateway] ○ ○

[JTEKT TOYOPUC-PC] - - [Ethernet(LS Industrial Systems XGK), Gateway] ○ ○

[HITACHI S10mini/S10V] - - [Ethernet(SIEMENS S7), Gateway] ○ ○

[FUJI MICREX-F] - - [Ethernet(SIEMENS OP), Gateway] ○ ○

[FUJI MICREX-SX SPH] - - [Ethernet(FUJI), Gateway] ○ ○

[GE (SNP-X)] - - [Ethernet(KEYENCE), Gateway] ○ ○

[SHIBAURA MACHINE TCmini] - - [MODBUS/TCP Master, Gateway] - -

[KOYO KOSTAC/DL] - - [MODBUS/TCP Slave, Gateway] - -

[LS Industrial Systems MASTER-K] - - [PROFIBUS DP] - -

[Hirata HNC] - - [DeviceNet] - -

[IAI ROBO CYLINDER] - - [Ethernet(MICROCOMPUTER) ] - -

[IAI X-SEL] - - [Ethernet(SLMP), Gateway] ○ ○

[SICK Flexi Soft] - - [Ethernet(MELSERVO), Gateway] ○ ○

[Panasonic MINAS A4] - - [Ethernet(CC-Link IE Field Network Basic)] - -

Communication driver

Supported/
Unsupported

Communication driver

Supported/
Unsupported

Host 
station

Other 
stations

Host 
station

Other 
stations

Operator Authentication Reception 
signal (GS240.b13)

External Authentication Reception 
signal (GS240.b14) Authentication mode

OFF OFF The operator authentication not 
accepted

ON OFF The password authentication accepted 
(operator name + password)

ON ON The external authentication accepted
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(42)Insufficient Security Level Notification (GS241)
The bit turns on when the screen cannot be displayed because of the insufficient security level.

• b0: Use prohibited
• b1: Turns on when the overlap window 1 cannot be displayed.
• b2: Turns on when the overlap window 2 cannot be displayed.
• b3: Turns on when the superimpose window 1 cannot be displayed.
• b4: Turns on when the superimpose window 2 cannot be displayed.
• b5 to b7: Use prohibited
• b8: Turns on when a called screen on the base screen cannot be displayed.
• b9: Turns on when a called screen on the overlap window 1 cannot be displayed.
• b10: Turns on when a called screen on the overlap window 2 cannot be displayed.
• b11: Turns on when a called screen on the superimpose window 1 cannot be displayed.
• b12: Turns on when a called screen on the superimpose window 2 cannot be displayed.
• b13 to b15: Use prohibited

b1 to b4 turn off when a screen is displayed.
b1 to b4 turn off when 0 is stored in a screen switching device.
b8 to b12 turn off when a called screen is displayed.

(43)Incorrect Login (GS242)
• b0: Turns on when an incorrect login is detected.

Turns off upon the lapse of the set login block time or unlocking an operator account by logging in as the 
administrator.

• b1: Turns on when any operator account is locked.
Turns off when no operator account is locked.

• b2 to b15: Use prohibited

(44)Object Direct Input Reception Notification (GS243)
• b1 to b14: Use prohibited
• b15: Turns on while an object is in the ready state for the data read by the barcode reader or RFID to be directly input.

(45)SoftGOT-GOT Link Status Control/Notification (GS244)
When the GOT network interaction function is enabled, only GS244.b2 operates.

• b0: Turns on while GT SoftGOT2000 communicates with the GOT.
• b1: Turns on when the GOT or GT b2: SoftGOT2000 obtains the authorization.
• b2: Notifies whether the GOT or GT SoftGOT2000 is in use.

0: GOT
1: GT SoftGOT2000 (Changes to 0 if GT SoftGOT2000 does not communicate with the GOT.)

• b3: Turns on when the GOT obtains the exclusive authorization. (Always off for GT SoftGOT2000)
• b4: Turns on when the dedicated screen for the utility or the extended function is displayed. (Always off for GT 

SoftGOT2000)
• b5 to b15: Use prohibited

(46)Drive Accessibility (GS251)
Notifies whether each drive is accessible.

• b0: Turns on when data can be read and written from and to drive A.
• b1: Turns on when data can be read and written from and to drive B
• b2: Turns on when data can be read and written from and to drive E.
• b3: Turns on when data can be read and written from and to drive F
• b4: Turns on when data can be read and written from and to drive G.
• b5: Turns on when data can be read from drive N.
• b6 and b7: Use prohibited
• b8: Turns on when data forbids writing to drive A.
• b9: Turns on when data forbids writing to drive B
• b10: Turns on when data forbids writing to drive E.
• b11: Turns on when data forbids writing to drive F.
• b12: Turns on when data forbids writing to drive G.
• b13 to b15: Use prohibited

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer
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(47)Error Detection Common Information (GS252)
• b0 to b7: Use prohibited
• b8: Turns on when the video signal for CH1 is not input.

The bit automatically turns off when the video signal for CH1 is input.
• b9: Turns on when the video signal for CH2 is not input.

The bit automatically turns off when the video signal for CH2 is input.
• b10: Turns on when the video signal for CH3 is not input.

The bit automatically turns off when the video signal for CH3 is input.
• b11: Turns on when the video signal for CH4 is not input.

The bit automatically turns off when the video signal for CH4 is input.
• b12 to b13: Use prohibited
• b14: Turns on when the RGB signal for CH2 is not input.

The bit automatically turns off when the RGB signal for CH2 is input.
The bit turns off when b14 of the device specified for [Video/RGB Input Common] is turned off (to hide the RGB 
screen for CH2).
For details, refer to the following.

➟10.7 Displaying Image from a Personal Computer on the GOT (RGB Display Function)
• b15: Turns on when the RGB signal for CH1 is not input.

The bit automatically turns off when the RGB signal for CH1 is input.
The bit turns off when b15 of the device specified for [Video/RGB Input Common] is turned off (to hide the RGB 
screen for CH1).
For details, refer to the following.

➟10.7 Displaying Image from a Personal Computer on the GOT (RGB Display Function)

(48)Invalid Access from Ethernet Port 1, Invalid Access from Ethernet Port 2 (GS254)
Notifies an invalid write/read request from GT Designer3 while the writing or reading of package data is disabled with the 
Ethernet Port 1 Access Control or Ethernet Port 2 Access Control device (GS454).
The following shows the correspondence between the Ethernet interfaces and the bits.

• b0: Available when the Prohibit System Package Write signal (GS454.b0) is on.
Turns on when the GOT receives a write request of package data (containing system applications) from GT 
Designer3 through the corresponding Ethernet interface.
When the Prohibit System Package Write signal (GS454.b0) turns off, this bit also turns off.

• b1: Available when the Prohibit Project Data Write signal (GS454.b1) is on.
Turns on when the GOT receives a write request of package data (containing project data) from GT Designer3 
through the corresponding Ethernet interface.
When the Prohibit Project Data Write signal (GS454.b1) turns off, this bit also turns off.

• b2 to b3: Use prohibited
• b4: Available when the Prohibit System Package Write signal (GS454.b4) is on.

Turns on when the GOT receives a write request of package data (containing system applications) from GT 
Designer3 through the corresponding Ethernet interface.
When the Prohibit System Package Write signal (GS454.b4) turns off, this bit also turns off.

• b5: Available when the Prohibit Project Data Write signal (GS454.b5) is on.
Turns on when the GOT receives a write request of package data (containing project data) from GT Designer3 
through the corresponding Ethernet interface.
When the Prohibit Project Data Write signal (GS454.b5) turns off, this bit also turns off.

• b6 to b7: Use prohibited
• b8: Available when the Prohibit Project Data Read signal (GS454.b8) is on.

Turns on when the GOT receives a read request of package data from GT Designer3 through the corresponding 
Ethernet interface.
When the Prohibit Project Data Read signal (GS454.b8) turns off, this bit also turns off.

• b9 to b11: Use prohibited

GOT Ethernet interface Bit number

GT27, GT25-S, 
GT25-V (excluding 
GT2505-V)

Ethernet standard port b0, b1, b8

Ethernet extended port b4, b5, b12

GT25-W, GS25
Ethernet standard port 1 b0, b1, b8

Ethernet standard port 2 b4, b5, b12

GT2505-V, 
GT25HS-V, GT23, 
GT21, GS21

Ethernet standard port b0, b1, b8
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• b12: Available when the Prohibit Project Data Read signal (GS454.b12) is on.
Turns on when the GOT receives a read request of package data from GT Designer3 through the corresponding 
Ethernet interface.
When the Prohibit Project Data Read signal (GS454.b12) turns off, this bit also turns off.

• b13 to b15: Use prohibited
➟12.1.3 ■5 (34) Ethernet Port 1 Access Control, Ethernet Port 2 Access Control (GS454)

(49)Intensity Notification (GS255)
Stores the current intensity and the brightness adjustment mode of the GOT display section.

• b0 to b14: Store the current intensity.

For GT23

• b15: Sets the current brightness adjustment mode.
The bit turns on when the brightness adjustment mode is set to the low intensity.
The bit turns off when the brightness adjustment mode is set to normal.

The Intensity Notification is stored when the Intensity Control or the Intensity Control by the intensity adjustment function 
of the utility is performed.
For the details of the Intensity Control, refer to the following.

➟12.1.3 ■5 (35) Intensity Control (GS455)
For the intensity adjustment function of the utility, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)

(50)FA Transparent Status (GS256)
Notifies the status of the FA transparent function.
The relationship between the stored value and the FA transparent status is as indicated below.
0: Ordinary monitoring
1: In the transparent mode
2: In the pass-through mode

(51)Printer Status Information (GS258)
GT25-W, GT2505-V, GT23, GT21, GS25, and GS21 support b3 only.

• b0: This bit is available when a PictBridge-compatible printer is used.
Turns on when the printer is connected to the printer unit of the GOT.
Turns off when the connection is disconnected.

• b1: This bit is available when a PictBridge-compatible printer is used.
Turns on when a warning occurs while the printer is connected.
Turns off after the error restoration.

• b2: This bit is available when a PictBridge-compatible printer is used.
Turns on when a fatal error occurs while the printer is connected.
Turns off after the error restoration.

• b3: This bit is available when a PictBridge-compatible printer, serial printer, or Ethernet printer is used.
Turns on when the printer is ready to print.

Intensity Notified value Intensity Notified value Intensity Notified value Intensity Notified value

1 1 9 109 17 117 25 125

2 102 10 3 18 118 26 126

3 103 11 111 19 5 27 127

4 104 12 112 20 120 28 7

5 2 13 113 21 121 29 129

6 106 14 4 22 122 30 130

7 107 15 115 23 6 31 131

8 108 16 116 24 124 32 8

Intensity Notified value Intensity Notified value Intensity Notified value Intensity Notified value

1 102 5 3 9 118 13 126

2 104 6 112 10 120 14 7

3 106 7 4 11 122 15 130

4 108 8 116 12 124 16 8
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Turns off while the printer is starting up (including warming up), or printing is in progress.
When printing cannot be executed while this signal is on, confirm that a function that executes printing (such as the 
hard copy function) completes the processing.
You can confirm that the processing is completed by the Hard Copy Output signal (System signal 2-1.b7).

• b4 to b15: Use prohibited

(52)Ethernet Printer Error Info (GS259)
The following printers are supported: Ethernet printers.
Notifies the error code of the latest error that has occurred in the printer.
For details on the error codes, refer to the following Technical Bulletin.

➟List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-
0160)

(53)Integer←→Real Number Conversion Status (GS260)
The following script types are supported: project script, screen script, and script part.
Stores the conversion completion notification and error occurrence status into each bit.
If the Conversion Start Indication (GS460.b15) is turned off (0), each bit becomes 0.

➟12.1.3 ■5 (38) Conversion Start Indication (GS460)
• b0 to b13: Use prohibited
• b14: Turns on when error occurs during conversion processing by GOT.

(Stores an error code in GS261)
➟(54) Integer←→Real Number Conversion Error Code (GS261)

• b15: Turns on when conversion is completed by GOT.

(54)Integer←→Real Number Conversion Error Code (GS261)
The following script types are supported: project script, screen script, and script part.
Stores the error during conversion.
Stores 0 when the conversion is completed normally.
Error codes stored in GS261 are as follows.

(55)System Alarm GOT Error Channel No. (GS262)
If a system alarm (GOT error) occurs, the corresponding channel No. is stored.
0 is stored when the system alarm is cleared.
With some system alarms, channel numbers are not stored.
For details, refer to the following manuals.

➟GOT2000 Series User's Manual (Utility)

(56)System Alarm CPU Error Channel No. (GS263)
If a system alarm (CPU error) occurs, the corresponding channel No. is stored.
0 is stored when the system alarm is cleared.

(57)System Alarm Network Error Channel No.(GS264)
If a system alarm (network error) occurs, the corresponding channel No. is stored.
0 is stored when the system alarm is cleared.

(58)SNTP Time Synchronization Setting Status (GS265)
Notifies the status of the SNTP time synchronization setting.
The following shows the values to be stored.
0: No SNTP time synchronization setting or failure
1: Synchronizing with SNTP

Error code Description Remarks

1 The Conversion Start Indication is not initialized.

The conversion processing is not executed.

2 The setting of the Conversion Start Indication is incorrectly configured.

3 The number of devices is out of range.

4 The device is out of range.

5 The conversion source and destination are the same.

6 Not used -

7 Conversion error (such as an overflow) The conversion processing continues.
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(59)SNTP Time Query Result (GS266 to GS272)
Stores the SNTP Time Query Result.
The following shows the values to be stored.

• GS266: The four-digit year data is stored.
• GS267: The month data, 01 to 12, is stored.
• GS268: The day data, 01 to 31, is stored.
• GS269: The hour data, 00 to 23, is stored.
• GS270: The minute data, 00 to 59, is stored.
• GS271: The second data, 00 to 59, is stored.
• GS272: The day-of-the-week data, 0 to 6, is stored.

(0: Sunday 1: Monday 2: Tuesday 3: Wednesday 4: Thursday 5: Friday 6: Saturday)

(60)Monitoring Interval Timeout Count (GS275)
The cumulative number of times that monitoring interval timeout has occurred is stored.
If monitoring interval timeout occurs frequently, check the number of job settings and the trigger condition setting.

(61)Document Display Status (GS276)
• b0: Turns on when a specified file is not displayable.

Turns off when the file is displayed appropriately.
For the cause of the display failure, refer to the following.

➟8.26.5 Precautions for a document display object
• b1: Turns on when a PDF file cannot be cached for display.

Turns off when the cached PDF file is displayed.
For the cause of the cache failure, refer to the following.

➟8.26.5 Precautions for a document display object
• b2: Turns on when a PDF document is displayed in high quality (144 dpi resolution).
• b3: Turns on when the display size of the document is changed by GS523.b3.

Turns off when GS523.b3 is turned off.
➟12.1.3 ■5 (61) Document Display Common Control (GS523)

• b4 to b15: Use prohibited

(62)Notify Automatic Connection Status (GS277)
Notifies the communication status between the controllers supporting the automatic connection and the GOT.
GT21 and GS21 support b0 to b3.

• b0: Turns on when the automatic connection is enabled in the setting of the controller (CH1).
• b1: Turns on when the automatic connection process is completed between the controller (CH1) and the GOT.
• b2: Turns on when the automatic connection is enabled in the setting of the controller (CH2).
• b3: Turns on when the automatic connection process is completed between the controller (CH2) and the GOT.
• b4: Turns on when the automatic connection is enabled in the setting of the controller (CH3).
• b5: Turns on when the automatic connection process is completed between the controller (CH3) and the GOT.
• b6: Turns on when the automatic connection is enabled in the setting of the controller (CH4).
• b7: Turns on when the automatic connection process is completed between the controller (CH4) and the GOT.
• b8 to b15: Use prohibited

(63)Report Page Number (GS278)
Specify this device for a numerical print object on a report screen to output page numbers at the position where the object 
is placed.

(64)Standard SD Card Information (GS279)
• b0: Turns on when an SD card is inserted into the standard SD card interface.

Check the Drive Accessibility device (GS251) to see if the SD card is accessible.
➟12.1.3 ■2 (46) Drive Accessibility (GS251)

• b1 to b15: Use prohibited

(65)Faulty Monitor Station signal (CH1 to CH14) (GS280, GS300, GS320, GS340)
• b0 to b7: Stores the number of faulty monitor stations with the Ethernet connection. (Except the Ethernet connection 

with a microcomputer)
• b8 to b15: Use prohibited
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(66)Faulty Station Information (CH1 to CH4) (GS281 to GS288, GS301 to GS308, GS321 to GS328, GS341 
to GS348)
If a communication error occurs in a station that is connected to the GOT by using an applicable connection type, the 
corresponding bit turns on. The applicable connection types are as follows: Ethernet connection, CC-Link IE Controller 
Network connection, CC-Link IE Field Network connection, temperature controller connection, inverter connection, and 
servo amplifier connection.
(For the multi-channel connection, the bit of the device corresponding to each channel No. (CH1 to CH4) turns on.)
0: No error
1: Error
When the faulty station is restored from the error, the bit turns off.
The following shows the communication drivers that support the device.
○: Supported, -: Not supported

Communication driver

Supported/
Unsupported

Communication driver

Supported/
Unsupported

Host 
station

Other 
stations

Host 
station

Other 
stations

[Bus Q] ○ - [Panasonic MINAS A5] ○ ○

[Bus A/QnA] ○ - [Muratec MPC] ○ ○

[Serial(MELSEC)] ○ - [Computer] - -

[AJ71QC24, MELDAS C6*] ○ - [MELSERVO-J4,J3,J2S/M,JE] ○ ○

[AJ71C24/UC24] ○ - [FREQROL 500/700/800,SENSORLESS 
SERVO] ○ ○

[CC-Link(G4)] ○ - [FREQROL 800] ○ ○

[MELSECNET/H] - - [FREQROL(Batch monitor)] ○ ○

[CC-Link Ver.2(ID)] - - [OMRON THERMAC/INPANEL NEO] ○ ○

[CC-Link IE Controller Network] - ○*1 [OMRON Digital Temperature Controller] ○ ○

[CC-Link IE Field Network] - ○*1 [azbil SDC/DMC] ○ ○

[CC-Link IE TSN]*2 - - [azbil DMC50] ○ ○

[MELSEC-FX] ○ - [RKC SR Mini HG(MODBUS)] ○ ○

[MELSEC-WS] ○ - [FUJI Temperature Controller/Digital Controller] ○ ○

[MEI Nexgenie] ○ ○ [YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced] ○ ○

[Multidrop(Slave)] - - [Shinko Technos Controller] ○ ○

[OMRON SYSMAC] ○ - [CHINO MODBUS device] ○ ○

[YASKAWA GL] ○ - [MODBUS/RTU Master] ○ ○

[YASKAWA CP9200 (H)] ○ - [MODBUS/RTU Slave] - -

[YASKAWA CP9300MS (MC compatible)] ○ - [Ethernet(MITSUBISHI ELECTRIC), Gateway] ○ ○

[YASKAWA MP2000/MP900/CP9200SH] ○ - [Ethernet(FX), Gateway] ○ ○

[AB SLC500, AB 1:N] ○ ○ [Ethernet(FREQROL), Gateway] ○ ○

[AB MicroLogix] ○ ○ [Ethernet(FREQROL(Batch monitor)), Gateway] ○ ○

[AB MicroLogix(Extended)] ○ ○ [Ethernet(YASKAWA), Gateway] ○ ○

[AB Control/CompactLogix] ○ - [Ethernet(YASKAWA MP3000), Gateway] ○ ○

[SHARP JW] ○ - [Ethernet(YASKAWA High Speed Ethernet 
Server), Gateway] ○ ○

[TOSHIBA PROSEC T/V] ○ - [Ethernet(YOKOGAWA), Gateway] ○ ○

[HITACHI IES HIDIC H] ○ - [Ethernet(AB), Gateway] ○ ○

[HITACHI IES HIDIC H(Protocol2)] ○ - [Ethernet(AB MicroLogix), Gateway] ○ ○

[Panasonic MEWNET-FP] ○ - [Ethernet(AB Tag), Gateway] ○ ○

[Panasonic MEWTOCOL-7] ○ - [Ethernet(OMRON), Gateway] ○ ○

[SIEMENS S7-200] ○ - [Ethernet(OMRON NJ/NX), Gateway] ○ ○

[SIEMENS S7-300/400] ○ ○ [Ethernet(TOSHIBA nv), Gateway] ○ ○

[YOKOGAWA FA500/FA-M3/STARDOM] ○ - [Ethernet(HITACHI IES), Gateway] ○ ○
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*1 Only the faulty station can be detected in the same network.
*2 To detect a faulty station in the CC-Link IE TSN connection, use the following GOT special registers (GS).

➟12.1.3 ■3 (77) Faulty Station Information (CC-Link IE TSN) (GS1281 to GS1288)

When the GOT is connected to the AZBIL temperature controller (DMC50), the specified station number of the DMC50 
differs from the station numbers of the other controllers.
The following shows station numbers for each device.

(a) Correspondence between station numbers and device bits (when connecting to a controller other 
than the AZBIL temperature controller (DMC50))
The station corresponding to each device bit differs according to whether the Ethernet connection is used or not.

• With the Ethernet connection: 1 to 128

• With other than the Ethernet connection: 0 to 127

[Serial(KEYENCE)] ○ - [Ethernet(HITACHI), Gateway] ○ ○

[JTEKT TOYOPUC-PC] ○ ○ [Ethernet(LS Industrial Systems XGK), Gateway] ○ ○

[HITACHI S10mini/S10V] ○ - [Ethernet(SIEMENS S7), Gateway] ○ ○

[FUJI MICREX-F] ○ ○ [Ethernet(SIEMENS OP), Gateway] ○ ○

[FUJI MICREX-SX SPH] ○ - [Ethernet(FUJI), Gateway] ○ ○

[GE (SNP-X)] ○ ○ [Ethernet(KEYENCE), Gateway] ○ ○

[SHIBAURA MACHINE TCmini] ○ - [MODBUS/TCP Master, Gateway] ○ ○

[KOYO KOSTAC/DL] ○ ○ [MODBUS/TCP Slave, Gateway] - -

[LS Industrial Systems MASTER-K] ○ ○ [PROFIBUS DP] ○ -

[Hirata HNC] ○ ○ [DeviceNet] ○ -

[IAI ROBO CYLINDER] ○ ○ [Ethernet(MICROCOMPUTER) ] - -

[IAI X-SEL] ○ - [Ethernet(SLMP), Gateway] ○ ○

[SICK Flexi Soft] ○ - [Ethernet(MELSERVO), Gateway] ○ ○

[Panasonic MINAS A4] ○ ○ [Ethernet(CC-Link IE Field Network Basic)] - -

Device Ethernet setting No.

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
281

GS
301

GS
321

GS
341 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

GS
282

GS
302

GS
322

GS
342 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17

GS
283

GS
303

GS
323

GS
343 48 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33

GS
284

GS
304

GS
324

GS
344 64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

GS
285

GS
305

GS
325

GS
345 80 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65

GS
286

GS
306

GS
326

GS
346 96 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81

GS
287

GS
307

GS
327

GS
347 112 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97

GS
288

GS
308

GS
328

GS
348 128 127 126 125 124 123 122 121 120 119 118 117 116 115 114 113

Device Station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
281

GS
301

GS
321

GS
341 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 *1

Communication driver

Supported/
Unsupported

Communication driver

Supported/
Unsupported

Host 
station

Other 
stations

Host 
station

Other 
stations
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*1 This station number is not used for the CC-Link IE Controller Network connection.
*2 This station number is not used for the CC-Link IE Field Network connection.

(b) Correspondence between station numbers and device bits (when connecting to the AZBIL 
temperature controller (DMC50))

(1) Range of detectable faulty stations
The GOT cannot detect errors with the station No. 128 or later, or the station number and the sub station 9-
0 or later.

(2) Detecting a faulty station whose station number is specified with the value of a GOT data 
register
When an error occurs with the station number specified on GT Designer3, the operation differs according to 
the controller used.
(a) When using other than the AZBIL temperature controller (DMC50)

When an error occurs with the station number specified on GT Designer3, the own station number of 
the error temperature controller, inverter, or servo amplifier is detected.
(For example, when the station number specified on GT Designer3 is 110 and the own station number 
of the temperature controller or servo amplifier is 10, the bit for the station number 10 turns on.)

(b) When using the AZBIL temperature controller (DMC50)
When the station number is specified with the value of the GOT data register (GD), the GOT cannot 
detect errors.
For details of specifying station numbers, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

GS
282

GS
302

GS
322

GS
342 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

GS
283

GS
303

GS
323

GS
343 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33 32

GS
284

GS
304

GS
324

GS
344 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49 48

GS
285

GS
305

GS
325

GS
345 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65 64

GS
286

GS
306

GS
326

GS
346 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81 80

GS
287

GS
307

GS
327

GS
347 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97 96

GS
288

GS
308

GS
328

GS
348

127 
*1*2

126 
*1*2

125 
*1*2

124 
*1*2

123 
*1*2

122 
*1*2

121 
*1*2 120 119 118 117 116 115 114 113 112

Device Station-Sub station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
281

GS
301

GS
321

GS
341 1-15 1-14 1-13 1-12 1-11 1-10 1-9 1-8 1-7 1-6 1-5 1-4 1-3 1-2 1-1 1-0

GS
282

GS
302

GS
322

GS
342 2-15 2-14 2-13 2-12 2-11 2-10 2-9 2-8 2-7 2-6 2-5 2-4 2-3 2-2 2-1 2-0

GS
283

GS
303

GS
323

GS
343 3-15 3-14 3-13 3-12 3-11 3-10 3-9 3-8 3-7 3-6 3-5 3-4 3-3 3-2 3-1 3-0

GS
284

GS
304

GS
324

GS
344 4-15 4-14 4-13 4-12 4-11 4-10 4-9 4-8 4-7 4-6 4-5 4-4 4-3 4-2 4-1 4-0

GS
285

GS
305

GS
325

GS
345 5-15 5-14 5-13 5-12 5-11 5-10 5-9 5-8 5-7 5-6 5-5 5-4 5-3 5-2 5-1 5-0

GS
286

GS
306

GS
326

GS
346 6-15 6-14 6-13 6-12 6-11 6-10 6-9 6-8 6-7 6-6 6-5 6-4 6-3 6-2 6-1 6-0

GS
287

GS
307

GS
327

GS
347 7-15 7-14 7-13 7-12 7-11 7-10 7-9 7-8 7-7 7-6 7-5 7-4 7-3 7-2 7-1 7-0

GS
288

GS
308

GS
328

GS
348 8-15 8-14 8-13 8-12 8-11 8-10 8-9 8-8 8-7 8-6 8-5 8-4 8-3 8-2 8-1 8-0

Device Station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0
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(3) Restrictions on the CC-Link IE Field Network connection
If a submaster station exists on the network, use a CC-Link IE Field Network communication unit (GT15-
J71GF13-T2) with software version C or later.
You can find the software version on the rating plate of the unit. Check the 10th digit of the serial number.

(4) Dealing with a faulty station
(a) Automatically stopping monitoring a faulty station

The GOT automatically stops monitoring a connected station where a communication timeout error 
occurs so as not to retard the monitoring of the other connected stations. (No setting is required.)
The following shows an example of the GOT operation when a communication error occurs in station 
No. 3.
Example) When the GOT is connected to a temperature controller

(b) Disconnecting the specified station from the GOT with the GOT special register (GS)
You can disconnect the specified controller from the GOT by using the GOT special register (GS).

➟12.1.3 ■5 (65) Monitor Station Disconnection (CH1 to CH4) (GS531 to GS538, GS541 to GS548, 
GS551 to GS558, GS561 to GS568)

Doing so helps avoid the occurrence of a communication timeout error even if the specified controller is 
removed for changing a module or other reasons. (No system alarm appears on the GOT.)
However, depending on the type of connection cables used, the GOT may not monitor the controllers 
that are connected to the removed one.

(67)Channel Observation Notification Information (GS299, GS319, GS339, GS359)
Notifies the communication status of each channel.

• b0: Turns on if a connection error occurs.
• b1 to b15: Use prohibited

The following shows the communication drivers that support the device.
○: Supported, -: Not supported

Station 
No.1

Station 
No.3

Station 
No.6

Station 
No.7

Station 
No.16

GOT

2) Communication time-out occurs with 
    station No.3. 
3) The GOT stops monitoring operations of 
    station No.3. 
4) The GOT checks if the communication 
    time-out with station No.3 is cancelled.

5) Communication time-out with station No.3 is 
    cancelled. 
6) The GOT automatically restarts monitoring 
    operations of station No.3.

Station 
No.1

Station 
No.3

Station 
No.6

Station 
No.7

Station 
No.16

1) The GOT correctly communicates 
    with controllers.

5)

6)

GOT

Station 
No.1

Station 
No.3

Station 
No.6

Station 
No.7

Station 
No.16

GOT Communication 
timeout occurred

2)

3)

4)

Communication driver Supported/
Unsupported Communication driver Supported/

Unsupported

[Bus Q] ○ [Panasonic MINAS A5] ○

[Bus A/QnA] ○ [Muratec MPC] ○

[Serial(MELSEC)] ○ [Computer] -

[AJ71QC24, MELDAS C6*] ○ [MELSERVO-J4,J3,J2S/M,JE] ○

[AJ71C24/UC24] ○ [FREQROL 500/700/800,SENSORLESS SERVO] ○
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[CC-Link(G4)] ○ [FREQROL 800] ○

[MELSECNET/H] - [FREQROL(Batch monitor)] ○

[CC-Link Ver.2(ID)] - [OMRON THERMAC/INPANEL NEO] ○

[CC-Link IE Controller Network] - [OMRON Digital Temperature Controller] ○

[CC-Link IE Field Network] - [azbil SDC/DMC] ○

[CC-Link IE TSN] - [azbil DMC50] ○

[MELSEC-FX] ○ [RKC SR Mini HG(MODBUS)] ○

[MELSEC-WS] ○ [FUJI Temperature Controller/Digital Controller] ○

[MEI Nexgenie] ○ [YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced] ○

[Multidrop(Slave)] - [Shinko Technos Controller] ○

[OMRON SYSMAC] ○ [CHINO MODBUS device] ○

[YASKAWA GL] ○ [MODBUS/RTU Master] ○

[YASKAWA CP9200 (H)] ○ [MODBUS/RTU Slave] -

[YASKAWA CP9300MS (MC compatible)] ○ [Ethernet(MITSUBISHI ELECTRIC), Gateway] ○

[YASKAWA MP2000/MP900/CP9200SH] ○ [Ethernet(FX), Gateway] ○

[AB SLC500, AB 1:N] ○ [Ethernet(FREQROL), Gateway] ○

[AB MicroLogix] ○ [Ethernet(FREQROL(Batch monitor)), Gateway] ○

[AB MicroLogix(Extended)] ○ [Ethernet(YASKAWA), Gateway] ○

[AB Control/CompactLogix] ○ [Ethernet(YASKAWA MP3000), Gateway] ○

[SHARP JW] ○ [Ethernet(YASKAWA High Speed Ethernet Server), 
Gateway] ○

[TOSHIBA PROSEC T/V] ○ [Ethernet(YOKOGAWA), Gateway] ○

[HITACHI IES HIDIC H] ○ [Ethernet(AB), Gateway] ○

[HITACHI IES HIDIC H(Protocol2)] ○ [Ethernet(AB MicroLogix), Gateway] ○

[Panasonic MEWNET-FP] ○ [Ethernet(AB Tag), Gateway] ○

[Panasonic MEWTOCOL-7] ○ [Ethernet(OMRON), Gateway] ○

[SIEMENS S7-200] ○ [Ethernet(OMRON NJ/NX), Gateway] ○

[SIEMENS S7-300/400] ○ [Ethernet(TOSHIBA nv), Gateway] ○

[YOKOGAWA FA500/FA-M3/STARDOM] ○ [Ethernet(HITACHI IES), Gateway] ○

[Serial(KEYENCE)] ○ [Ethernet(HITACHI), Gateway] ○

[JTEKT TOYOPUC-PC] ○ [Ethernet(LS Industrial Systems XGK), Gateway] ○

[HITACHI S10mini/S10V] ○ [Ethernet(SIEMENS S7), Gateway] ○

[FUJI MICREX-F] ○ [Ethernet(SIEMENS OP), Gateway] ○

[FUJI MICREX-SX SPH] ○ [Ethernet(FUJI), Gateway] ○

[GE (SNP-X)] ○ [Ethernet(KEYENCE), Gateway] ○

[SHIBAURA MACHINE TCmini] ○ [MODBUS/TCP Master, Gateway] ○

[KOYO KOSTAC/DL] ○ [MODBUS/TCP Slave, Gateway] -

[LS Industrial Systems MASTER-K] ○ [PROFIBUS DP] ○

[Hirata HNC] ○ [DeviceNet] ○

[IAI ROBO CYLINDER] ○ [Ethernet(MICROCOMPUTER) ] -

[IAI X-SEL] ○ [Ethernet(SLMP), Gateway] ○

[SICK Flexi Soft] ○ [Ethernet(MELSERVO), Gateway] ○

[Panasonic MINAS A4] ○ [Ethernet(CC-Link IE Field Network Basic)] -

Communication driver Supported/
Unsupported Communication driver Supported/

Unsupported
12. APPENDICES
12.1 GOT Internal Device

12 - 39



(68)GOT Network No./Station No. Notification (CH1 to CH4) (GS376 to GS383)
When the GOT starts, the devices store a network number and a station number of the GOT connected with the Ethernet 
connection.
When the GOT is connected with other than the Ethernet connection, the devices store 0.

■3 Write device (GS640 to GS1791)

(1) Error Device Data Transfer ID (GS642)
Stores the device data transfer ID with the executed device data if an error occurs during device data transfer.

(2) Device Data Transfer Error Count (GS643)
Stores the number of error times with the executed device data during the device data transfer. (Maximum 65535 times)
When errors occur 65535 times or more, the value remains 65535.
The device data transfer ID with the executed device data is stored in the error device data transfer ID.

(3) Device Data Transfer Processing Time (GS644)
Stores the device data transfer processing time for one time. (0 to 60000 (×10ms))
Stores 60000 (×10ms) when the device data transfer processing time is 600 seconds or more.

(4) Device Data Transfer ID (GS645)
Stores the device data transfer ID with the executed device data transfer.

(5) Device Data Transfer Min. Processing Time (GS646)
Stores the minimum processing time in all of the processing times stored in the Device Data Transfer Processing Time 
(GS644).
(0 to 60000 (×10ms))

(6) Device Data Transfer ID (Min. Processing Time) (GS647)
Stores the device data transfer ID with the executed device data transfer when GS646 stores the minimum processing 
time.

(7) Device Data Transfer Max. Processing Time (GS648)
Stores the maximum processing time in all of the processing times stored in the Device Data Transfer Processing Time 
(GS644).
(0 to 60000 (×10ms))

(8) Device Data Transfer ID (Max. Processing Time) (GS649)
Stores the device data transfer ID with the executed device data transfer when GS648 stores the maximum processing 
time.

(9) Present Time (GS650 to GS635)
Stores the current time with BCD code.
The day-of-the-week data, 0 to 6, is stored.
(0: Sunday 1: Monday 2: Tuesday 3: Wednesday 4: Thursday 5: Friday 6: Saturday)
Example) When the error occurrence date is 15:30:20 May 15, 2013 (Wednesday)

(10)Touch Status External Notification (X-coordinate) (GS654)
Stores the x-coordinate of touched position when the GOT screen is touched on.

(11)Touch Status External Notification (Y-coordinate) (GS655)
Stores the Y-coordinate of touched position when the GOT screen is touched on.

Device
Description

CH1 CH2 CH3 CH4

GS376 GS378 GS380 GS382 Network number (1 to 239)

GS377 GS379 GS381 GS383 Station number (1 to 64)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GS650

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GS651

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error occurrence date: 2013 / 5 / 15   15:30:20 (3: Wednesday) (Binary Coded Decimal)

GS652

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GS653

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
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(12)Touch Status External Notification (Touch Status) (GS656)
The following values are stored in the device depending on the touched screen types when the GOT screen is touched 
on.
0: Without touching
1: Touching on the base screen
2: Touching touchable objects on the base screen
11: Touching on the overlap window 1
12: Touching touchable objects on the overlap window 1
21: Touching on the overlap window 2
22: Touching touchable objects on the overlap window 2
31: Touching on the overlap window 3
32: Touching touchable objects on the overlap window 3
41: Touching on the overlap window 4
42: Touching touchable objects on the overlap window 4
51: Touching on the overlap window 5
52: Touching touchable objects on the overlap window 5
61: Touching on the video window
71: Touching on the key window
72: Touching touchable objects on the key window
81: Touching on the comment window
91: Touching on the popup display

(13)Trigger Backup Processing Setting No. Notification (GS657)
The GOT notifies users of the trigger backup processing status.
Stores the channel number of the backup trigger setting if a trigger backup is being processed.
Stores 0 when the trigger backup is not processed.

(14)Extended External Input Status Notification signal (GS658 to GS665)
When the 128-point input can be executed with the external I/O function, the bit for an input scan signal turns on.
When the 128-point input cannot be executed, the devices are always off.
To enable the 128-point input, turn on GS517.b0 (External I/O Function Notification/External I/O Control Function).
0: Signal off
1: Signal on
The following shows the devices for each bit.

Controlling a signal with controllers
The above signals can be controlled with controllers when the trigger action and the script function are used.

(15)Sound Status Information (GS668)
• b1 to b14: Use prohibited
• b15: Turns on with a jack disconnection when the sound output function is used.

Turns off without a jack disconnection.

Scan 
signal

Extended 
External 

Input 
Status 

Notificatio
n signal

External Input signal

X0 X1 X2 X3 X4 X5 X6 X7 X8 X9 XA XB XC XD XE XF

XSCN0 GS658 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN1 GS659 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN2 GS660 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN3 GS661 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN4 GS662 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN5 GS663 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN6 GS664 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

XSCN7 GS665 b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15
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(16)Sound File Number During Play (GS669)
Stores the sound file number during the play in the device.
When no sound file exists during the play, 0 is stored in the device.

(17)Number of Trigger Buffer Data (GS670)
Stores the number of the trigger buffer data.
When many trigger buffer data is stored for a long time, the GOT becomes busy. As a result, some data may not be 
collected.
Check the number of job settings for which the trigger buffering is enabled and the trigger condition setting.

(18)Trigger Buffer Overflow Count (GS671)
Stores the cumulative number of times that a trigger buffer overflow has occurred.
The trigger buffer overflow means that the 129th trigger data is discarded without being buffered when 128 trigger data 
is already buffered.
If a trigger buffer overflow occurs frequently, check the number of job settings for which the trigger buffering is enabled 
and the trigger condition setting.

(19)Trigger Buffer Overflow Flag per Job (GS672 to GS675)
Indicates the status of trigger buffer overflow for each job.
When a trigger buffer overflow occurs for a job, the GOT internal device corresponding to the job turns on.
The following shows the GOT internal devices corresponding to jobs from 1 to 64.

(20)Notify Number of Hard Copy Output Screens signal (GS693)
Stores the number of screens whose the hard copy outputs are completed.
When the start trigger condition is satisfied, 0 is stored.
The target screens are counted one by one at completion of output regardless of the output file format or output settings 
of the target screen.

(21)Object Position upon Cursor Display (GS694 and GS695)
Store the upper-left coordinates of the object (numerical input or text input) on which the cursor is displayed.

• GS694: X coordinate
• GS695: Y coordinate

The devices store 0 if the cursor is not displayed on any object.

(22)Expanded Base Screen Position (GS696 and GS697)
Stores the upper-left coordinates of the area of the expanded base screen currently displayed on the GOT.

• GS696: X coordinate
• GS697: Y coordinate

The devices store 0 when the original size base screen is displayed on the GOT.

(23)Touch Position Color Acquisition Complete signal (GS980)
• b0: Turns on when the Touch Position Color (GS981 to 983) stores a value.

Turning on the bit cancels the touch position color acquisition ready status.
Turning off the Touch Position Color Acquisition Ready signal (GS630.b0) turns off the bit.

• b1 to b15: Use prohibited

(24)Touch Position Color (GS981 to GS983)
Notifies the color information at the touched position.
The GOT acquires the color information with RGB. The following GOT special registers (GS) store the RGB values (0 to 
255).

• R: GS981
• G: GS982
• B: GS983

Turning on the Touch Position Color Acquisition Ready signal (GS630.b0) stores -1 in R, G, and B each.
After the signal (GS630.b0) turns on, the GOT acquires the color information at the first touch and release of the screen.

Device Job
Correspondence of the jobs and the GOT internal devices

b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 b10 b11 b12 b13 b14 b15

GS672 1 to 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

GS673 17 to 32 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

GS674 33 to 48 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48

GS675 49 to 64 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64
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(25)Authorization Guarantee Status Notification signal (GS984)
Not available to GT SoftGOT2000 (Multiple channels).
This is disabled when the GOT network interaction function is used.
Stores the remaining authorization guarantee time (seconds) when the authorization guarantee time is set in GT 
SoftGOT2000 (Single channel) or the GOT.

(26)Executing File Transfer ID Notification (GS987)
Stores the file transfer setting ID of the file transfer setting in execution.

(27)Communicating FTP Server ID Notification (GS988)
Stores the FTP server setting ID of the currently connected destination FTP server setting.

(28)File Transfer Error No. (GS989)
Stores the error code of an error that occurred in the file transfer.
Turn on GS401.b0 to clear the stored error code.
The following shows the list of the error code to be stored.

Error code Details of error and cause Corrective action

1 The connection to the FTP server has failed.

• Check the IP address of the FTP server.
• Check if a cable is connected.
• Check HUB connection status.
• Check if the FTP server is working on the target device.
• Check if the destination FTP server setting is configured properly.

2 Authentication of the FTP server has failed. Check if the user name and password are correct.

3 FTP server is busy. Wait until the FTP server recovers from the busy status. *1

4 FTP communication timeout
• Check if the communication line has not been physically interrupted.
• Check the communication congestion.

5 Access to the target file to be written has failed.

• Check if the write destination drive is enabled.
• Check if the write destination drive has enough available space.
• Check if the file is not write-prohibited.
• When using the GOT as the FTP server, check if the GOT is in the write 

enable mode.

6 Access to the target file to be read has failed.

• Check if the target file exists.
• Check whether the file name specified by the file transfer setting is 

correct or not.
• Check if the data storage has been installed on the GOT.
• Check if the SD card cover has been closed.
• Check that the SD card access switch is turned on.
• Check that the write protection for the SD card is canceled.

7
The file whose size exceeds the file size 
supported by the GOT was attempted to be 
transferred.

Check if the size of the transfer file is within 2GB.

10

• For the FTP transfer
The GOT folder name is invalid.

• For the GOT internal transfer
The transfer source folder name is invalid.

Check that the GOT folder name or the transfer source folder name does 
not contain invalid characters, such as two-byte characters.

11 The transfer file name is invalid. Check if the transfer file name does not include invalid characters such as 
two-byte characters.

12 The transfer source folder and destination folder 
have the same path.

Set different paths to the transfer source folder and the transfer destination 
folder.

13 Drive N is specified for both the transfer source 
folder and the transfer destination folder.

Specify drive N for only one of the transfer source folder and the transfer 
destination folder.

50 The drive specification on the PLC side is 
incorrect.

When a PLC is used as a FTP server, only drive 2 (Memory card (ROM)) 
is accessible.
Check if the setting of [FTP Server Folder] specified in the [File Transfer 
Setting] dialog is correct.

100 The destination FTP server setting ID which 
does not exist has been specified.

• Check if the destination FTP server setting ID specified by [File transfer 
setting] is correct.

• Add the required destination FTP server setting.

200 Access to the storage device has failed when the 
file name or folder name is specified indirectly. Check if the device setting used for the indirect specification is correct.
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*1 The status in which a request from the client cannot be accepted
*2 Even if a warning is given, the file transfer process does not stop.

(29)File Transfer Status (GS990)
Notifies the file transfer processing status.

• b0: Turns on when the GOT (FTP client) writes files to the FTP server, or the GOT transfers files within itself.
• b1: Turns on when the GOT (FTP client) reads files from the FTP server.
• b2: Notifies the connection mode of the GOT (FTP client) and the FTP server.

ON: PASV mode
OFF: PORT mode

• b3 to b13: Use prohibited
• b14: Turns on when the error with which the processing can be continued occurs during the file transfer.

Turns off when the Clear File Transfer Error signal (GS401.b0) is turned on.
• b15: Turns on when the error with which the processing cannot be continued occurs during the file transfer.

Files cannot be transferred while this signal is on.
Turns off when the Clear File Transfer Error signal (GS401.b0) is turned on.

(30)Number of Transfer Target Files (GS991)
Stores the total number of files to be transferred.
When the transfer file name is specified with the wild card, the total count includes the files which are not transferred due 
to an invalid number of characters for the folder name or other causes.
(However, the total count does not include only the files which have invalid names consisting of such as two-byte 
characters.)
Holds the device value until the processing for the next file transfer ID is started.

(31)Number of Transferred Files (GS992)
Stores the total number of files which is completely transferred.
The total count includes the files which are not transferred due to the error or other causes.
Holds the device value until the processing for the next file transfer ID is started.

(32)Recipe Status(GS1010)
Notifies the processing status of recipe data when the recipe data is manipulated using a special function switch ([Switch 
Action]: [Recipe Data Operation]).

507 The total number of characters of the folder path 
and transfer file name exceeds the limit.

Check that the total number of the characters does not exceed the limit as 
shown below.
• <GOT folder path>\<Transfer file name>: 78 characters or less (including 

backward slash marks)
• <FTP server folder path>\<Transfer file name>: 250 characters or less 

(including backward slash marks)
• <Transfer source folder path>\<Transfer file name>: 78 characters or 

less (including backward slash marks)
• <Transfer destination folder path>\<Transfer file name>: 78 characters or 

less (including backward slash marks)

600 *2
The file transfer has been skipped because the 
total number of characters of the folder path and 
transfer file name exceeds the limit. (Only when 
the file is specified with a wildcard character)

601 *2
Since invalid characters had been used for the 
transfer file name, the transfer processing was 
skipped. (only when the file is specified with the 
wild card)

Check if the transfer file name does not include invalid characters such as 
two-byte characters.

602 *2
Since the write operation for the file had failed, 
the transfer processing was skipped. (only when 
the file is specified with the wild card)

• Another function might have been using the transfer file. Transfer the file 
again.

• Check if the write destination drive has enough available space.

603 *2
Since the read operation for the file had failed, 
the transfer processing was skipped. (only when 
the file is specified with the wild card)

• The file might have been deleted before being transferred. Check if all the 
files have been transferred to the destination folder.

• Check if the data storage has been installed on the GOT.
• Check if the SD card cover has been closed.
• Check that the SD card access switch is turned on.
• Check that the write protection for the SD card is canceled.

606 *2
Since the file specified with the wild card had not 
existed, the file was not transferred. (only when 
the file is specified with the wild card)

Check if the specified file name is correct.

607 *2
The file whose size exceeds the file size 
supported by the GOT was attempted to be 
transferred. (only when the file is specified with 
the wild card)

Check if the size of the transfer file is within 2GB.

610 *2 Deleting the source file has failed. Check if the source file is in the deletable status.

Error code Details of error and cause Corrective action
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➟9.3.3 ■3 (4) Exporting a recipe file by using a special function switch (Recipe data operation)
• b0: Turns on when the recipe data is imported.
• b1: Turns on when the recipe data is exported.
• b2: Turns on when the recipe special control is executed.

Turns off after the control is complete and the Execute Special Control signal (GS1800.b2) is turned off.
• b3 to b13: Use prohibited
• b14: Turns on after importing or exporting the recipe data is complete.

Turns off when another recipe data manipulation is performed or the Clear Status Information signal (GS1800.b14) 
is turned on.

➟12.1.3 ■6 (7) Recipe Control (GS1800)
• b15: Turns on when importing or exporting the recipe data fails.

Turns off when another recipe data manipulation is performed or the Clear Status Information signal (GS1800.b14) 
is turned on.

➟12.1.3 ■6 (7) Recipe Control (GS1800)

(33)Recipe Special Control Result (GS1011)
Notifies the result of the recipe special control.
Stores 0 if the control is complete.
Stores a value other than 0 if an error occurs.
For the error codes and corrective actions, refer to the following.

➟9.3.3 ■8 (12) Error code list

This device is reset to 0 upon turn-on of the Execute Special Control signal (GS1800.b2).

(34)Recipe Special Control No. (GS1012)
Notifies the search result (record No.) of the recipe special control.
This device is reset to 0 upon turn-on of the Execute Special Control signal (GS1800.b2).

(35)Recipe Display (Record List) Target Recipe No. (GS1013)
Notifies the recipe number for the records displayed on the recipe display (record list).
This device stores 0 in the following cases.

• No recipe display (record list) is placed on the screen.
• A nonexistent recipe setting is specified to be displayed on the recipe display (record list).
• The recipe display (record list) is not displayed because the display condition is unsatisfied or the security level is 

insufficient.
For information on how to link the recipe function with the recipe display (record list) by using GOT special registers, refer 
to the following.

➟9.3.3 ■9 Link with the recipe display (record list) by using GOT special registers

(36)Recipe Display (Record List) Selected Record No. (GS1014)
Stores the record number selected on the recipe display (record list).
This device stores 0 in the following cases.

• No recipe display (record list) is placed on the screen.
• A nonexistent recipe setting is specified to be displayed on the recipe display (record list).
• The recipe display (record list) is not displayed because the display condition is unsatisfied or the security level is 

insufficient.
• No cursor is displayed on the recipe display (record list).

For information on how to link the recipe function with the recipe display (record list) by using GOT special registers, refer 
to the following.

➟9.3.3 ■9 Link with the recipe display (record list) by using GOT special registers

(37)Recipe Display (Record List) Target Record No. (GS1015)
Stores the record number of the record manipulated on the recipe display (record list) while GS1809.b0 is on.
This device stores 0 when the record number is not identified.

➟12.1.3 ■6 (15) Recipe Display (Record List) Control (GS1809)

(38)Recipe Display (Record List) Record Manipulation Result (GS1016)
Notifies the record manipulation result of the recipe display (record list) while GS1809.b0 is on.
This device turns off when GS1809.b15 is turned on.

➟12.1.3 ■6 (15) Recipe Display (Record List) Control (GS1809)
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• b0: Turns on when the device values of a record and those of the PLC match at the record verification.
• b1: Turns on when the device values of a record and those of the PLC do not match at the record verification.
• b2: Turns on when no device value is set in the record at the record verification.
• b3 to b10: Use prohibited
• b11: Turns on when a record verification is unsuccessful.
• b12: Turns on when a record deletion is unsuccessful.
• b13: Turns on when a record writing is unsuccessful.
• b14: Turns on when a record reading is unsuccessful.
• b15: Turns on when a record renaming is unsuccessful.

(39)Video File Maintenance Information (GS1022)
Notifies the amount of usage of the CF card or the number of video files in the card in the multimedia unit while the Start 
Video File Information Notification signal (GS522.b1) is on.
This function is usable only when [Enable] is selected and [Event Trigger Device] is set in [Before-After Event Recording 
Setting] on the [Recording Setting] tab of the [Multimedia] dialog.
This device turns off upon the turn-off of the Start Video File Information Notification signal (GS522.b1).

➟12.1.3 ■5 (60) Special Control During Specific Function Execution (GS522)
• b0: Turns on when the amount of usage of the CF card reaches 60%.
• b1: Turns on when the amount of usage of the CF card reaches 80%.
• b2: Turns on when the number of video files in the CF card reaches 80.
• b3: Turns on when the number of video files in the CF card reaches 110.
• b4: Turns on when the number of video files in the CF card reaches 150.
• b5: Turns on when the number of video files in the CF card reaches 400.
• b6: Turns on when the number of video files in the CF card reaches 450.
• b7: Turns on when the number of video files in the CF card reaches 500.
• b8 to b15: Use prohibited

(40)USB Drive Common Information (GS1024)
• b0: Turns on when the USB memory connected to drive E on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b0) turns on.
• b1: Turns on when the USB memory connected to drive F on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b1) turns on.
• b2: Turns on when the USB memory connected to drive B on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b2) turns on.
• b3: Turns on when the USB memory connected to drive G on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b3) turns on.
• b4: Turns on when the USB memory connected to drive E on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b4) turns on.
• b5: Turns on when the USB memory connected to drive F on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b5) turns on.
• b6: Turns on when the USB memory connected to drive B on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b6) turns on.
• b7: Turns on when the USB memory connected to drive G on the GOT is ready for removal after the USB Drive 

Common Control (GS1824.b7) turns on.
• b8: Turns on when the USB memory (drive E) connected to the USB interface on the GOT is ready for use.
• b9: Turns on when the USB memory (drive F) connected to the USB interface on the GOT is ready for use.
• b10: Turns on when the USB memory (drive B) connected to the USB interface on the GOT is ready for use.
• b11: Turns on when the USB memory (drive G) connected to the USB interface on the GOT is ready for use.
• b12: Turns on when the USB memory (drive E) connected to the USB interface on the GOT is ready for use.
• b13: Turns on when the USB memory (drive F) connected to the USB interface on the GOT is ready for use.
• b14: Turns on when the USB memory (drive B) connected to the USB interface on the GOT is ready for use.
• b15: Turns on when the USB memory (drive G) connected to the USB interface on the GOT is ready for use.

When GS1824.b0 to b7 are turned off, b0 to b7 of this device are also turned off.
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer
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(41)RGB Signal Input Status Notification (GS1025)
Notifies the RGB signal input, supporting the resolution and the refresh rate of the RGB signal or not, and the RGB input 
unit status.
When the GT27-R2-Z is used, the device notifies the input status of the channel set for the input source of the RGB 
screen.

• b0: Turns on when the RGB signal is input.
• b1: Turns on when the GOT supports the input resolution and refresh rate.
• b2: Turns on when the RGB input unit operates normally.
• b3 to b15: Use prohibited

(42)RGB Signal Resolution (Horizontal) (GS1026)
When GS1025.b0 turns on, the device stores the horizontal resolution (dots) of the RGB signal.
When the RGB signal does not exist or the resolution of the signal is unclear, the device stores 0.

(43)RGB Signal Resolution (Vertical) (GS1027)
When GS1025.b0 turns on, the device stores the vertical resolution (dots) of the RGB signal.
When the RGB signal does not exist or the resolution of the signal is unclear, the device stores 0.

(44)RGB Signal Refresh Rate (GS1028)
When GS1025.b0 turns on, the device stores the refresh rate (Hz) of the RGB signal.
When the RGB signal does not exist or the refresh rate of the signal is unclear, the device stores 0.

(45)Video/RGB Display Object Status (CH1 to CH2) (GS1030, GS1035)
Notifies information on the video/RGB display object.

• b0: Turns on when a signal is input.
• b1: Turns on when the target GOT supports the resolution and refresh rate indicated by input signals.
• b2: Turns on when the RGB input unit operates normally.
• b3 to b15: Use prohibited

(46)Video/RGB Display Object Horizontal Resolution (CH1 to CH2) (GS1031, GS1036)
Stores the horizontal resolution (dots) indicated by an input signal for the video/RGB display object.
Stores 0 if no signal is input or the resolution cannot be identified.

(47)Video/RGB Display Object Vertical Resolution (CH1 to CH2) (GS1032, GS1037)
Stores the vertical resolution (dots) indicated by an input signal for the video/RGB display object.
Stores 0 if no signal is input or the resolution cannot be identified.

(48)Video/RGB Display Object Refresh Rate (CH1 to CH2) (GS1033, GS1038)
Stores the refresh rate (Hz) indicated by an input signal for the video/RGB display object.
Stores 0 if no signal is input or the refresh rate cannot be identified.

(49)Wireless Processing Security Information (GS1040)
Notifies operations executed via a wireless LAN.

• b0: Turns on when the GOT receives a write request of the package data (containing system applications) from GT 
Designer3 while the Prohibit System Package Write signal (GS1840.b0) is on.
When the Prohibit System Package Write signal (GS1840.b0) turns off, this bit also turns off.

• b1: Turns on when the GOT receives a write request of the package data (containing project data) from GT Designer3 
while the Prohibit Project Data Write signal (GS1840.b1) is on.
When the Prohibit Project Data Write signal (GS1840.b1) turns off, this bit also turns off.

• b2 to b7: Use prohibited
• b8: Turns on when the GOT receives a read request of data from GT Designer3 while the Prohibit Project Data Read 

signal (GS1840.b8) is on.
When the Prohibit Project Data Read signal (GS1840.b8) turns off, this bit also turns off.

• b9 to b15: Use prohibited

(50)Ethernet Port 1 Subnet Mask Notification (GS1043, GS1044), Ethernet Port 2 Subnet Mask Notification 
(GS1045, GS1046)
Stores the subnet mask that is specified for the GOT Ethernet port 1 or port 2 in hexadecimal.
Example) Subnet mask for Ethernet port 1: 255.255.255.0 (decimal)
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When the subnet mask for Ethernet port 2 is invalid, 0.0.0.0 (decimal) is stored in GS1045 and GS1046.

(51)Wireless LAN Port Subnet Mask Notification (GS1047 to GS1048)
Stores the subnet mask that is specified for the wireless LAN interface in hexadecimal.
Example) Subnet mask: 255.255.255.0 (decimal)

When the wireless LAN function is disabled, 0.0.0.0 (decimal) is stored.

(52)Default Gateway Notification (GS1049 to GS1050)
Stores the default gateway set in the GOT in hexadecimal.
Example) Default gateway: 192.168.3.1 (decimal)

(53)Wireless LAN Status Notification (GS1060)
Notifies the information on the GOT wireless LAN function.

• b0: Turns on when the wireless LAN function is enabled.
Turns off when the wireless LAN function is disabled.

• b1: Turns on when the GOT (operation mode: station) connects to the wireless LAN access point.
• b2: Notifies the GOT operation mode.

0: Station
1: Access point

• b3 to b15: Use prohibited

(54)Reception Field Intensity Notification (GS1061)
Stores a value (0 to 4) indicating the intensity of radio waves received by access points when the wireless LAN function 
is used.
Zero indicates a disconnection, and the other values indicate the intensity of radio waves. The larger the value, the higher 
the intensity.

(55)Access Point MAC Address Notification(GS1067 to GS1069)
Stores the MAC address of the access point to which the GOT is connected in hexadecimal.
Example) When the MAC address is 78-2B-CB-AA-3F-C6(16 bits)

(56)Number of Connected Stations (GS1072)
Stores the number of stations connected to the GOT (operation mode: access point) on a wireless LAN.
Stores 0 when the GOT operates as a station (operation mode: station) or the wireless LAN function is disabled.

GS1043
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1044
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Subnet Mask: FF. FF. FF. 00 (Hexadecimal)

GS1047
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1048
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Subnet Mask: FF. FF. FF. 00 (Hexadecimal)

GS1049
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1050
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Default Gateway: C0. A8. 03. 01 (Hexadecimal)

GS1067

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1068

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Access Point MAC address: 78 - 2B - CB - AA - 3F - C6 (Hexadecimal)

GS1069

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
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(57)Label Name Resolution Status (Common, CH1 to CH4) (GS1080, GS1081 to GS1084)
Notifies the status of the label name resolution.
GS1080 notifies the status relevant to all channels.
GS1081 to GS1084 each notify the status of the corresponding channel (CH1 to CH4).

• b0: Use prohibited
• b1: Notifies that the label name resolution is being executed.

For GS1080, this bit turns on while the label name resolution is being executed on any of the channels.
For GS1081 to GS1084, this bit turns on while the label name resolution is being executed on the corresponding 
channel.

• b2: Notifies that the label name resolution completes.
For GS1080, this bit turns on when the label name resolution completes on all the channels.
For GS1081 to GS1084, this bit turns on when the label name resolution completes on the corresponding channel.

• b3: Notifies that the label name resolution is canceled.
For GS1080, this bit turns on when the label name resolution is canceled on any of the channels.
For GS1081 to GS1084, this bit turns on when the label name resolution is canceled on the corresponding channel.

• b4 to b14: Use prohibited
• b15: Notifies that an error has occurred during the label name resolution.

For GS1080, this bit turns on when a label name resolution error occurs on any of the channels.
For GS1081 to GS1084, this bit turns on when a label name resolution error occurs on the corresponding channel.
For how to use the bits, refer to the following.

➟6.1.4 ■5 (3) Label name resolution performed by a user

(58)HMS Communication Module Version (GS1110 to GS1111)
Stores the version of the HMS communication module used.
Example) When the communication module version is 01.02.01

(59)HMS Communication Module Error Details (GS1112 to GS1113)
• GS1112.b0 to b7: Store an exception code of the network object.
• GS1112.b8 to b15: Store an exception code of the Anybus object.
• GS1113.b0 to b7: Store the Anybus status.
• GS1113.b8 to b15: Store the error code of an Anybus message.

(60)CC-Link IE TSN Module Communication Test Status (GS1114)
Notifies the execution status of a communication test of the CC-Link IE TSN communication unit.

• b0: Turns on when a communication test is executed.
• b1: Is on while a communication test is being executed.
• b2: Turns on when a communication test is complete.
• b3 to b15: Use prohibited

Stores the IP address of the VNC client communicating with the VNC server in hexadecimal.

GS1110

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1111

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Major version: 01 Minor version: 02 Build version: 01
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For details on the communication test of the CC-Link IE TSN communication unit, refer to the following.
➟GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1

(61)CC-Link IE TSN Module Communication Test Error (GS1115)
Notifies that an error has occurred during a communication test of the CC-Link IE TSN communication unit.

• b0: Turns on if there is a problem with the port 1 side of the CC-Link IE TSN communication unit.
• b1: Turns on if there is a problem with the connection interface (port 1) or the Ethernet cable terminal connected to 

port 1.
• b2: Turns on if there is a problem with the Ethernet cable connected to port 1 of the CC-Link IE TSN communication 

unit.
• b3 to b7: Use prohibited
• b8: Turns on if there is a problem with the port 2 side of the CC-Link IE TSN communication unit.
• b9: Turns on if there is a problem with the connection interface (port 2) or the Ethernet cable terminal connected to 

port 2.
• b10: Turns on if there is a problem with the Ethernet cable connected to port 2 of the CC-Link IE TSN communication 

unit.
• b11 to b15: Use prohibited

For details on the communication test of the CC-Link IE TSN communication unit, refer to the following.
➟GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1

(62)Special Function Switch Special Control (GS1220)
• b0: Turns on when an error occurs during the iQSS utility special control.

This signal turns off at a start of the iQSS utility special control.

(63)iQSS Utility Special Control Error Sensor Device No. (GS1221)
Stores the affected sensor device number when an error occurs during the iQSS utility special control.
Data type: Unsigned binary
When no error occurs, the reset value (65535) is stored.

(64)VNC Server Operation Status Notification (GS1230)
• b0: Turns on while the VNC server communicates with the VNC client.
• b1: Turns on when the VNC client is allowed to display the VNC server screen and to remotely operate the VNC 

server.
Turns off when the VNC client is allowed to only display the VNC server screen.

• b2: Turns on when the VNC client holds the authorization.
Turns off when the VNC server holds the authorization.

• b3 to b14: Use prohibited
• b15: Turns on when the VNC client holds the authorization.

Turns off when the VNC server holds the authorization.

(65)Communicating VNC Client Information Notification (GS1231, GS1232)
Stores the IP address of the VNC client communicating with the VNC server in hexadecimal.
Example) When the IP address of the VNC client is 192.168.3.10 (Decimal)

Communication test 
executed

Communication test 
completed

ON

OFFb2

ON

OFFb1 OFF

ON

OFFb0
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(66)VNC Server Authorization Guarantee Status Notification (GS1233)
Stores the remaining authorization guarantee time (second).

(67)Insufficient Security Level Notification (GS1241)
Turns on when the screen cannot be displayed because of the insufficient security level.

• b0: Turns on when the overlap window 3 cannot be displayed.
• b1: Turns on when the overlap window 4 cannot be displayed.
• b2: Turns on when the overlap window 5 cannot be displayed.
• b3 to b7: Use prohibited
• b8: Turns on when a called screen on the overlap window 3 cannot be displayed.
• b9: Turns on when a called screen on the overlap window 4 cannot be displayed.
• b10: Turns on when a called screen on the overlap window 5 cannot be displayed.
• b11 to b15: Use prohibited

(68)Report Output Status: Print Date/Time (Year) (GS1271)
Specify this device for a numerical print object on a report screen to output the date (year) on which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(69)Report Output Status: Print Date/Time (Month) (GS1272)
Specify this device for a numerical print object on a report screen to output the date (month) on which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(70)Report Output Status: Print Date/Time (Day) (GS1273)
Specify this device for a numerical print object on a report screen to output the date (day) on which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(71)Report Output Status: Print Date/Time (Hour) (GS1275)
Specify this device for a numerical print object on a report screen to output the time (hour) at which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(72)Report Output Status: Print Date/Time (Minute) (GS1276)
Specify this device for a numerical print object on a report screen to output the time (minute) at which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(73)Report Output Status: Print Date/Time (Second) (GS1277)
Specify this device for a numerical print object on a report screen to output the time (second) at which the file print function 
prints a report.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(74)Report Output Status: Total Number of Pages (GS1278)
Specify this device for a numerical print object on a report screen to output the total number of pages at the position where 
the object is placed.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

GS1231

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1232

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

IP address of VNC client: C0. A8. 03. 0A (Hexadecimal)
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(75)Report Output Status: Operator Name (GS1279)
Specify this device for a text print object on a report screen to output the name of the operator who prints a report using 
the file print function.
This device is activated only when the report function outputs data to a file.
This device is activated on a report screen only.

(76)Faulty Monitor Station signal (CC-Link IE TSN) (GS1280)
• b0 to b7: Stores the number of faulty monitor stations in the CC-Link IE TSN connection.
• b8 to b15: Use prohibited

(77)Faulty Station Information (CC-Link IE TSN) (GS1281 to GS1288)
Turn on the bit that corresponds to the faulty monitor station number in the CC-Link IE TSN network.
0: No error
1: Error
When the faulty station is restored from the error, the bit turns off.
The following shows station numbers for each device.

(78)CC-Link IE TSN Connection Status (GS1297)
Notifies whether the GOT is connectable to the network in CC-Link IE TSN Connection.
After checking the connection with the master station at the startup, the GOT is connectable to the network.

• 0 or 1: Not connectable because the connection has not been confirmed.
• 2: Connectable

(79)Number of Connected GOT Mobile Function Clients (GS1400)
Stores the number of clients connected to the server (GOT).

(80)GOT Mobile Function Connection Status (GS1401)
Notifies the connection status between the server (GOT) and each client.
GT27, GT25, and GS25 support b0 to b5.

• b0: Use prohibited
• b1: Turns on when client 1 connects to the server (GOT).
• b2: Turns on when client 2 connects to the server (GOT).
• b3: Turns on when client 3 connects to the server (GOT).
• b4: Turns on when client 4 connects to the server (GOT).
• b5: Turns on when client 5 connects to the server (GOT).
• b6: Turns on when client 6 connects to the server (GOT).
• b7: Turns on when client 7 connects to the server (GOT).
• b8: Turns on when client 8 connects to the server (GOT).
• b9: Turns on when client 9 connects to the server (GOT).
• b10: Turns on when client 10 connects to the server (GOT).
• b11: Turns on when client 11 connects to the server (GOT).
• b12: Turns on when client 12 connects to the server (GOT).
• b13: Turns on when client 13 connects to the server (GOT).
• b14: Turns on when client 14 connects to the server (GOT).
• b15: Turns on when client 15 connects to the server (GOT).

(81)Authorization Status Information (GS1460)
Notifies the information on the authorization of the GOT network interaction function.
This device is activated in an applicable GOT in the control group.

Device
Station number corresponding to each bit

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS1281 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

GS1282 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

GS1283 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33 32

GS1284 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49 48

GS1285 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65 64

GS1286 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81 80

GS1287 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97 96

GS1288 - - - - - - - 120 119 118 117 116 115 114 113 112
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• b0: Turns on when the equipment obtains the authorization.
• b1: Turns on when the equipment displays a screen in which the authorization control is enabled.
• b2 to b15: Use prohibited

(82)Master GOT IP Address (GS1461 to GS1462)
Store the IP address of the master GOT in hexadecimal when GS1460.b0 turns on.
Store 0 when GS1460.b0 is off.
These devices are activated in an applicable GOT in the control group.
Example) When the IP address of the master GOT is 192.168.3.18 (decimal)

(83)Time Elapsed from Authorization Acquisition (GS1463)
Stores the time (second) elapsed since GS1460.b0 turned on.
If the time exceeds 65536 seconds, the value update stops.
Stores 0 when GS1460.b0 is off.
This device is activated in an applicable GOT in the control group.

(84)Authorization Guarantee Time (GS1464)
Stores the remaining authorization guarantee time (second) when GS1460.b0 is on.
Stores 0 when GS1460.b0 is off.
This device is activated in an applicable GOT in the control group.

(85)Authorization Management Information (GS1465)
Notifies the information on the authorization of the GOT network interaction function.
This device is activated in the master GOT in the control group.

• b0: Turns on when any equipment in the control group obtains the authorization.
• b1: Turns on when equipment except the master GOT in the control group is prohibited from obtaining the 

authorization (when GS1796.b0 is on).
• b2: Turns on when all pieces of equipment including the master GOT in the control group are prohibited from 

obtaining the authorization (when GS1796.b2 is on).
• b3 to b15: Use prohibited

(86)Authorized Equipment IP Address (GS1466 to GS1467)
Store the IP address of the authorized equipment when GS1465.b0 turns on.
Store 0 when GS1465.b0 is off.
These devices are activated in the master GOT in the control group.
Example) When the IP address of the authorized equipment is 192.168.3.19 (decimal)

(87)Authorized Equipment Type (GS1468)
Stores the type of the authorized equipment when GS1465.b0 turns on.

When GS1465.b0 is off, 0 is stored.
This device is activated in the master GOT in the control group.

GS1461

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1462

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GOT IP address: C0. A8. 03. 12 (Hexadecimal)

GS1466

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1467

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

IP address: C0. A8. 03. 13 (Hexadecimal)

Stored value Type

0 GOT

1 GT SoftGOT2000

2 GOT Mobile function client
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(88)Authorized Equipment ID Information (GS1469)
Stores the ID number of the authorized equipment when GS1465.b0 turns on.
The value to be stored varies depending on the type of the authorized equipment.

When GS1465.b0 is off, 0 is stored.
This device is activated in the master GOT in the control group.

(89)Authorization Use Time (GS1470)
Stores the time (second) elapsed since GS1465.b0 turned on.
If the time exceeds 65536 seconds, the value update stops.
When GS1465.b0 is off, 0 is stored.
This device is activated in the master GOT in the control group.

(90)GOT Ethernet Setting Change Status (GS1500)
Notifies the status of the GOT Ethernet setting change.
GT21 and GS21 support b0, b1, and b15.
• b0: Turns on while the Ethernet setting is being changed.
When the Execute GOT Ethernet Setting Change signal (GS1901.b0) turns off, this bit also turns off.

• b1: Turns on when the Ethernet setting change has completed.
• b2: Turns on when changes are made in the Ethernet setting by using the GOT Ethernet Setting Change devices 
(GS1900 to GS1908).
Restart the GOT to apply the new Ethernet setting.

• b3 to b14: Use prohibited
• b15: Turns on when an error occurs during the Ethernet setting change.

For the details of the GOT Ethernet Setting Change devices (GS1900 to GS1908), refer to the following.
➟12.1.3 ■6 (27) GOT Ethernet Setting Change (GS1900 to GS1908)

■4 Read device list

Type Value to be stored

GOT GOT ID number (1 to 32767)

GT SoftGOT2000 GT SoftGOT2000 module number (1 to 32767)

GOT Mobile function client GOT Mobile function client number (1 to 15)

Device Function Reference Supported 
models

GS0 to GS383 Write device ➟■1 Write device list

GS384 Script Common Control ➟12.1.3 ■5 (1) Script Common Control (GS384)

GS385 Script Monitoring Time ➟12.1.3 ■5 (2) Script Monitoring Time (GS385)

GS386 Project/Screen Script Initial Operation ➟12.1.3 ■5 (3) Project/Screen Script Initial 
Operation (GS386)

GS387 Object Script Common Control ➟12.1.3 ■5 (4) Object Script Common Control 
(GS387)

GS388 Object Script Monitoring Time ➟12.1.3 ■5 (5) Object Script Monitoring Time 
(GS388)

GS389 Object Script Initial Operation ➟12.1.3 ■5 (6) Object Script Initial Operation 
(GS389)

GS390 File Operation Data Storage Order ➟12.1.3 ■5 (7) File Operation Data Storage Order 
(GS390)

GS391 Use prohibited -

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
12 - 54 12. APPENDICES
12.1 GOT Internal Device



A
PP

EN
D

IC
ES

12
GS392 Start GD Device for Script Error Info Notification ➟12.1.3 ■5 (8) Start GD Device for Script Error Info 
Notification (GS392)

GS393 Use prohibited -

GS394 Number of Script Error Info Outputs ➟12.1.3 ■5 (9) Number of Script Error Info Outputs 
(GS394)

GS395 Script Error Info Output Common Control ➟12.1.3 ■5 (10) Script Error Info Output Common 
Control (GS395)

GS396 Start GD Device for Script Event Notification ➟12.1.3 ■5 (11) Start GD Device for Script Event 
Notification (GS396)

GS397 Use prohibited -

GS398 Number of Script Event Outputs ➟12.1.3 ■5 (12) Number of Script Event Outputs 
(GS398)

GS399 Script Event Output Common Control ➟12.1.3 ■5 (13) Script Event Output Common 
Control (GS399)

GS400 Gateway Common Information ➟12.1.3 ■5 (14) Gateway Common Control 
(GS400)

GS401 File Transfer Control ➟12.1.3 ■5 (15) File Transfer Control (GS401)

GS402 File Transfer Timeout Time ➟12.1.3 ■5 (16) File Transfer Timeout Time 
(GS402)

GS403 Use prohibited -

GS404 Maximum Number of Connected FTP Clients ➟12.1.3 ■5 (17) Maximum Number of Connected 
FTP Clients (GS404)

GS405 GOT Information Output Common Control ➟12.1.3 ■5 (18) GOT Information Output Common 
Control (GS405)

GS406 Serial No. Output Destination ➟12.1.3 ■5 (19) Serial No. Output Destination 
(GS406)

GS407 Use prohibited -

GS408 Ethernet Port 1 MAC Address Destination ➟12.1.3 ■5 (20) Ethernet Port 1 MAC Address 
Destination (GS408)
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models
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GS409 Use prohibited -

GS410 Ethernet Port 2 MAC Address Destination ➟12.1.3 ■5 (21) Ethernet Port 2 MAC Address 
Destination (GS410)

(Except 
GT2505-V and 
GT25HS-V)

GS411 Use prohibited -

GS412 Wireless LAN Interface MAC Address Destination ➟12.1.3 ■5 (22) Wireless LAN Interface MAC 
Address Destination (GS412)

(Except 
GT2505-V and 
GT25HS-V)

GS413 to GS422 Use prohibited -

GS423 Current Directory Designation when Logging in to the 
FTP Server Function

➟12.1.3 ■5 (23) Current Directory Designation 
when Logging in to the FTP Server Function 
(GS423)

GS424 to GS431 Use prohibited -

GS432 Start GD Device for Object Script Error Info 
Notification

➟12.1.3 ■5 (24) Start GD Device for Object Script 
Error Info Notification (GS432)

GS433 Use prohibited -

GS434 Number of Object Script Error Info Outputs ➟12.1.3 ■5 (25) Number of Object Script Error Info 
Outputs (GS434)

GS435 Object Script Error Info Output Common Control ➟12.1.3 ■5 (26) Object Script Error Info Output 
Common Control (GS435)

GS436 Start GD Device for Object Script Event Notification ➟12.1.3 ■5 (27) Start GD Device for Object Script 
Event Notification (GS436)

GS437 Use prohibited -
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GS438 Number of Object Script Event Outputs ➟12.1.3 ■5 (28) Number of Object Script Event 
Outputs (GS438)

GS439 Object Script Event Output Common Control ➟12.1.3 ■5 (29) Object Script Event Output 
Common Control (GS439)

GS440 to GS446 Use prohibited -

GS447 Exclusive Authorization Control ➟12.1.3 ■5 (30) Exclusive Authorization Control 
(GS447)

GS448 Use prohibited -

GS449 RGB Display Common Control ➟12.1.3 ■5 (31) RGB Display Common Control 
(GS449)

(Except 
GT2705-V)

GS450 Monitor Common Control ➟12.1.3 ■5 (32) Monitor Common Control (GS450)

GS451 Auto Screen Save Time ➟12.1.3 ■5 (33) Auto Screen Save Time (GS451)

GS452, GS453 Use prohibited -

GS454 Ethernet Port 1 Access Control, Ethernet Port 2 
Access Control

➟12.1.3 ■5 (34) Ethernet Port 1 Access Control, 
Ethernet Port 2 Access Control (GS454)

GS455 Intensity Control ➟12.1.3 ■5 (35) Intensity Control (GS455)

GS456 Character Code ➟12.1.3 ■5 (36) Character Code Control (GS456)

GS457 Pass-through Transparent Stop Control ➟12.1.3 ■5 (37) Pass-through Transparent Stop 
Control (GS457)

GS458 to GS459 Use prohibited -

Device Function Reference Supported 
models
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GS460 Conversion Start Indication ➟12.1.3 ■5 (38) Conversion Start Indication 
(GS460)

GS461 Number of Conversion Devices ➟12.1.3 ■5 (39) Number of Conversion Devices 
(GS461)

GS462 Conversion Source Head Device No. ➟12.1.3 ■5 (40) Conversion Source Head Device 
No. (GS462)

GS463 Conversion Destination Head Device No. ➟12.1.3 ■5 (41) Conversion Destination Head 
Device No. (GS463)

GS464 Storage Error Value ➟12.1.3 ■5 (42) Storage Error Value (GS464)

GS465 Remote Personal Computer Operation (Ethernet) 
Common Control

➟12.1.3 ■5 (43) Remote Personal Computer 
Operation (Ethernet) Common Control (GS465)

GS466 Unit of Drive Free Space ➟12.1.3 ■5 (44) Unit of Drive Free Space (GS466)

GS467 Monitor Common Control 2 ➟12.1.3 ■5 (45) Monitor Common Control 2 
(GS467)

GS468 Kanji Region Control ➟12.1.3 ■5 (46) Kanji Region Control (GS468)

GS469 to GS499 Use prohibited -

GS500 GT SoftGOT2000 Common Control ➟12.1.3 ■5 (47) GT SoftGOT2000 Common Control 
(GS500)

GS501, GS502 Application Start signal ➟12.1.3 ■5 (48) Application Start signal (GS501, 
GS502)

GS503 GT SoftGOT2000 Full Screen Size (Width) ➟12.1.3 ■5 (49) GT SoftGOT2000 Full Screen Size 
(Width) (GS503)

GS504 GT SoftGOT2000 Full Screen Size (Height) ➟12.1.3 ■5 (50) GT SoftGOT2000 Full Screen Size 
(Height) (GS504)

GS505 to GS507 Advanced Application Start signal ➟12.1.3 ■5 (51) Advanced Application Start signal 
(GS505, GS506 to GS507)

GS508, GS509 Use prohibited -

GS510 Device Data Transfer Information ➟12.1.3 ■5 (52) Device Data Transfer Information 
(GS510)

GS511 Touch Status Communication Control ➟12.1.3 ■5 (53) Touch Status Communication 
Control (GS511)
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GS512 Time Change Information ➟12.1.3 ■5 (54) Time Change Information (GS512)

GS513 to GS516 Changed Time ➟12.1.3 ■5 (55) Changed Time (GS513 to GS516)

GS517 External I/O Function Notification/External I/O 
Control Function

➟12.1.3 ■5 (56) External I/O Function Notification/
External I/O Control Function (GS517)

(Except 
GT2505-V and 
GT25HS-V)

GS518 Sound Output Common Control ➟12.1.3 ■5 (57) Sound Output Common Control 
(GS518)

GS519 Use prohibited -

GS520 Buffering And File Access Control ➟12.1.3 ■5 (58) Buffering And File Access Control 
(GS520)

GS521 Trigger Backup Data Send Delay ➟12.1.3 ■5 (59) Trigger Backup Data Send Delay 
(GS521)

GS522 Special Control During Specific Function Execution ➟12.1.3 ■5 (60) Special Control During Specific 
Function Execution (GS522)

GS523 Document Display Common Control ➟12.1.3 ■5 (61) Document Display Common 
Control (GS523)

GS524 Report Common Control ➟12.1.3 ■5 (62) Report Common Control (GS524)

GS525 Use prohibited -

GS526 Delay Hard Copy Execution ➟12.1.3 ■5 (63) Delay Hard Copy Execution 
(GS526)

GS527 to GS529 Use prohibited -

GS530 Network No. For Monitor Station Disconnected (CH1)
➟12.1.3 ■5 (64) Network No. For Monitor Station 

Disconnected (CH1 to CH4) (GS530, GS540, 
GS550, GS560)

Device Function Reference Supported 
models
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GS531 to GS538 Monitor Station Disconnection (CH1)
➟12.1.3 ■5 (65) Monitor Station Disconnection 

(CH1 to CH4) (GS531 to GS538, GS541 to 
GS548, GS551 to GS558, GS561 to GS568)

GS539 Channel Shutdown Control (CH1) ➟12.1.3 ■5 (66) Channel Shutdown Control (CH1 to 
CH4) (GS539, GS549, GS559, GS569)

GS540 Network No. For Monitor Station Disconnected (CH2)
➟12.1.3 ■5 (64) Network No. For Monitor Station 

Disconnected (CH1 to CH4) (GS530, GS540, 
GS550, GS560)

GS541 to GS548 Monitor Station Disconnection (CH2)
➟12.1.3 ■5 (65) Monitor Station Disconnection 

(CH1 to CH4) (GS531 to GS538, GS541 to 
GS548, GS551 to GS558, GS561 to GS568)

GS549 Channel Shutdown Control (CH2) ➟12.1.3 ■5 (66) Channel Shutdown Control (CH1 to 
CH4) (GS539, GS549, GS559, GS569)

GS550 Network No. For Monitor Station Disconnected (CH3)
➟12.1.3 ■5 (64) Network No. For Monitor Station 

Disconnected (CH1 to CH4) (GS530, GS540, 
GS550, GS560)

GS551 to GS558 Monitor Station Disconnection (CH3)
➟12.1.3 ■5 (65) Monitor Station Disconnection 

(CH1 to CH4) (GS531 to GS538, GS541 to 
GS548, GS551 to GS558, GS561 to GS568)

GS559 Channel Shutdown Control (CH3) ➟12.1.3 ■5 (66) Channel Shutdown Control (CH1 to 
CH4) (GS539, GS549, GS559, GS569)

GS560 Network No. For Monitor Station Disconnected (CH4)
➟12.1.3 ■5 (64) Network No. For Monitor Station 

Disconnected (CH1 to CH4) (GS530, GS540, 
GS550, GS560)

GS561 to GS568 Monitor Station Disconnection (CH4)
➟12.1.3 ■5 (65) Monitor Station Disconnection 

(CH1 to CH4) (GS531 to GS538, GS541 to 
GS548, GS551 to GS558, GS561 to GS568)

GS569 Channel Shutdown Control (CH4) ➟12.1.3 ■5 (66) Channel Shutdown Control (CH1 to 
CH4) (GS539, GS549, GS559, GS569)

GS570 to GS576 MODBUS Communication Control Function 
(Common)

➟12.1.3 ■5 (67) MODBUS Communication Control 
Function (GS570 to GS576, GS590 to GS596, 
GS597 to GS603, GS604 to GS610, GS611 to 
GS617)

GS577 to GS578 Use prohibited -

GS579 Channel Setting of MODBUS Communication Control 
Function

➟12.1.3 ■5 (68) Channel Setting of MODBUS 
Communication Control Function (GS579)

GS580 Microcomputer Connection Extended Setting (CH1)

➟12.1.3 ■5 (69) Microcomputer Connection 
Extended Setting (CH1 to CH4) (GS580 to 
GS583)GS581 Microcomputer Connection Extended Setting (CH2)
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models
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GS582 Microcomputer Connection Extended Setting (CH3)
➟12.1.3 ■5 (69) Microcomputer Connection 

Extended Setting (CH1 to CH4) (GS580 to 
GS583)GS583 Microcomputer Connection Extended Setting (CH4)

GS584 to GS589 Use prohibited -

GS590 to GS596 MODBUS Communication Control Function (CH1)
➟12.1.3 ■5 (67) MODBUS Communication Control 

Function (GS570 to GS576, GS590 to GS596, 
GS597 to GS603, GS604 to GS610, GS611 to 
GS617)

GS597 to GS603 MODBUS Communication Control Function (CH2)

➟12.1.3 ■5 (67) MODBUS Communication Control 
Function (GS570 to GS576, GS590 to GS596, 
GS597 to GS603, GS604 to GS610, GS611 to 
GS617)

GS604 to GS610 MODBUS Communication Control Function (CH3)

GS611 to GS617 MODBUS Communication Control Function (CH4)

GS618 to GS619 Use prohibited -

GS620 CC-Link IE TSN Control ➟12.1.3 ■5 (70) CC-Link IE TSN Control (GS620)

GS621 Operator Management Common Control ➟12.1.3 ■5 (71) Operator Management Common 
Control (GS621)

GS622 System Screen Operation Restriction ➟12.1.3 ■5 (72) System Screen Operation 
Restriction (GS622)

GS623 Specify Drive to Prohibit Write Operation (System 
Screen)

➟12.1.3 ■5 (73) Specify Drive to Prohibit Write 
Operation (System Screen) (GS623)

GS624 Specify Drive to Hide (System Screen) ➟12.1.3 ■5 (74) Specify Drive to Hide (System 
Screen) (GS624)

GS625 to GS629 Use prohibited -

GS630 Touch Position Color Acquisition Ready signal ➟12.1.3 ■5 (75) Touch Position Color Acquisition 
Ready signal (GS630)

GS631 Use prohibited -
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GS632 Date Format Control ➟12.1.3 ■5 (76) Date Format Control (GS632)

GS633 Specify Notification While Monitoring Stopped ➟12.1.3 ■5 (77) Specify Notification While 
Monitoring Stopped (GS633)

GS634 Specify Screen No. to be Displayed While Monitoring 
Stopped

➟12.1.3 ■5 (78) Specify Screen No. to be Displayed 
While Monitoring Stopped (GS634)

GS635 Base Screen Size Expansion Common Control ➟12.1.3 ■5 (79) Base Screen Size Expansion 
Common Control (GS635)

GS636 Specify Expanded Base Screen Position (X 
Coordinate) ➟12.1.3 ■5 (80) Specify Expanded Base Screen 

Position (GS636 and GS637)
GS637 Specify Expanded Base Screen Position (Y 

Coordinate)

GS638 Use prohibited -

GS639 GOT Reset Control ➟12.1.3 ■5 (81) GOT Reset Control (GS639)

GS640 to GS1791 Write device ➟12.1.3 ■1 ■1 Write device list

GS1792 VNC Server Function Control ➟12.1.3 ■6 (1) VNC Server Function Control 
(GS1792) (Only available 

to GT2107-W 
for GT21, only 
available to 
GS21-W-N for 
GS21)

GS1793 Use prohibited -

GS1794 Gesture Common Control ➟12.1.3 ■6 (2) Gesture Common Control (GS1794)

GS1795 Authorization Status Control ➟12.1.3 ■6 (3) Authorization Status Control 
(GS1795)

GS1796 Authorization Management Control ➟12.1.3 ■6 (4) Authorization Management Control 
(GS1796)

Device Function Reference Supported 
models
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GS1797 Log Viewer Common Control ➟12.1.3 ■6 (5) Log Viewer Common Control 
(GS1797)

GS1798 VNC Server GOT Processing Balance Control ➟12.1.3 ■6 (6) VNC Server GOT Processing 
Balance Control (GS1798)

GS1799 Use prohibited -

GS1800 Recipe Control ➟12.1.3 ■6 (7) Recipe Control (GS1800)

GS1801 Recipe Special Control Action ➟12.1.3 ■6 (8) Recipe Special Control Action 
(GS1801)

GS1802 Recipe Special Control Target Type ➟12.1.3 ■6 (9) Recipe Special Control Target Type 
(GS1802)

GS1803 Recipe Special Control Start GD Device No. ➟12.1.3 ■6 (10) Recipe Special Control Start GD 
Device No. (GS1803)

GS1804 Use prohibited -

GS1805 Recipe Special Control Recipe No. ➟12.1.3 ■6 (11) Recipe Special Control Recipe No. 
(GS1805)

GS1806 Recipe Special Control Record No. ➟12.1.3 ■6 (12) Recipe Special Control Record No. 
(GS1806)

GS1807 Recipe Special Control Row No. ➟12.1.3 ■6 (13) Recipe Special Control Row No. 
(GS1807)

GS1808 Recipe Special Control Points ➟12.1.3 ■6 (14) Recipe Special Control Points 
(GS1808)

GS1809 Recipe Display (Record List) Control ➟12.1.3 ■6 (15) Recipe Display (Record List) 
Control (GS1809)

GS1810 Special Function Switch Special Control ➟12.1.3 ■6 (16) Special Function Switch Special 
Control (GS1810)

GS1811 iQSS Utility Special Control Start GD Device No. 
Specification

➟12.1.3 ■6 (17) iQSS Utility Special Control Start 
GD Device No. Specification (GS1811)

GS1812 iQSS Utility Special Control Number of Parameters ➟12.1.3 ■6 (18) iQSS Utility Special Control 
Number of Parameters (GS1812)

GS1813 to GS1819 Use prohibited -

GS1820 SD Card Access Switch Status Control ➟12.1.3 ■6 (19) SD Card Access Switch Status 
Control (GS1820)
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GS1821 to GS1823 Use prohibited -

GS1824 USB Drive Common Control ➟12.1.3 ■6 (20) USB Drive Common Control 
(GS1824)

(Only available 
to GT2107-W 
for GT21)

GS1825 to GS1839 Use prohibited -

GS1840 Wireless Access Control 12.1.3 ■6 (21) Wireless Access Control (GS1840)

(Except 
GT2505-V and 
GT25HS-V)

GS1841 to GS1879 Use prohibited -

GS1880 Label Name Resolution Control ➟12.1.3 ■6 (22) Label Name Resolution Control 
(GS1880)

GS1881 to GS1884 Use prohibited -

GS1885 Prioritize Touch Switch Operation Control ➟12.1.3 ■6 (23) Prioritize Touch Switch Operation 
Control (GS1885)

GS1886 to GS1891 Use prohibited -

GS1892 GOT Mobile File Operation Security Level ➟12.1.3 ■6 (24) GOT Mobile File Operation 
Security Level (GS1892)

GS1893 to GS1895 Use prohibited -
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GS1896 GOT Mobile Common Control ➟12.1.3 ■6 (25) GOT Mobile Common Control 
(GS1896)

GS1897 to GS1898 Use prohibited -

GS1899 Time to Force Mobile Momentary Switch OFF ➟12.1.3 ■6 (26) Time to Force Mobile Momentary 
Switch OFF (GS1899)

GS1900 to GS1908 GOT Ethernet Setting Change ➟12.1.3 ■6 (27) GOT Ethernet Setting Change 
(GS1900 to GS1908)

GS1909 to GS1997 Use prohibited -

GS1998 Full-screen Display Control signal ➟12.1.3 ■6 (32) Full-screen Display Control signal 
(GS1998)

(Except 
GT2705-V)

GS1999 to GS2006 Video Window 1 Extended Control signal

➟12.1.3 ■6 (33) Video Window 1 to 4 and RGB 
Screen Extended Control signal (GS1999 to 
GS2006, GS2009 to GS2016, GS2019 to 
GS2026, GS2029 to GS2036, GS2039 to 
GS2045)

GS2007 to GS2008 Use prohibited -

GS2009 to GS2016 Video Window 2 Extended Control signal

➟12.1.3 ■6 (33) Video Window 1 to 4 and RGB 
Screen Extended Control signal (GS1999 to 
GS2006, GS2009 to GS2016, GS2019 to 
GS2026, GS2029 to GS2036, GS2039 to 
GS2045)

(Except 
GT2705-V)

GS2017 to GS2018 Use prohibited -

GS2019 to GS2026 Video Window 3 Extended Control signal

➟12.1.3 ■6 (33) Video Window 1 to 4 and RGB 
Screen Extended Control signal (GS1999 to 
GS2006, GS2009 to GS2016, GS2019 to 
GS2026, GS2029 to GS2036, GS2039 to 
GS2045)

(Except 
GT2705-V)

GS2027 to GS2028 Use prohibited -

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■5 Read device (GS384 to GS639)

(1) Script Common Control (GS384)
The following script types are supported: project script, screen script, and script part.
Notifies the information common to project scripts and screen scripts.
• b0: When this bit is turned on, the script error records are cleared as shown below.

GS14.b0, b7, b8, and b12 store 0.
GS15 stores -1.
GS16 to GS47 store 0.

• b1: When this bit is turned on, the script aborted due to an error is re-executed.
• b2 to b15: Use prohibited
For the precautions on the script error, refer to the following.

➟9.9.12 ■1 (11) Script error control and GOT status

(2) Script Monitoring Time (GS385)
The following script types are supported: project script, screen script, and script part.
Specify the monitoring time of a project script, screen script, or script of a script parts object in seconds.
If a script does not end after a lapse of the specified time, the script is aborted.
The setting range is [1] (second) to [300] (seconds).
If an invalid value is specified, 10 seconds are assumed.

(3) Project/Screen Script Initial Operation (GS386)
Set whether to run a project script, screen script, or script of a script parts object upon screen switching or others 
applicable processes.
• When GS386 stores 0, the script runs.
• When GS386 stores a nonzero value, the script does not run.
This setting is applied to the project scripts, screen scripts, and script parts where the following trigger types are set.
• [Rise]:
When the trigger device is on, the script runs upon screen switching or other applicable processes.

• [Fall]:
When the trigger device is off, the script runs upon screen switching or other applicable processes.

• [Rise/Fall]:

GS2029 to GS2036 Video Window 4 Extended Control signal

➟12.1.3 ■6 (33) Video Window 1 to 4 and RGB 
Screen Extended Control signal (GS1999 to 
GS2006, GS2009 to GS2016, GS2019 to 
GS2026, GS2029 to GS2036, GS2039 to 
GS2045)

(Except 
GT2705-V)

GS2037 to GS2038 Use prohibited -

GS2039 to GS2045 RGB Screen Extended Control signal

➟12.1.3 ■6 (33) Video Window 1 to 4 and RGB 
Screen Extended Control signal (GS1999 to 
GS2006, GS2009 to GS2016, GS2019 to 
GS2026, GS2029 to GS2036, GS2039 to 
GS2045)

(Except 
GT2705-V)

GS2046 to GS2047 Use prohibited -

Device Function Reference Supported 
models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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When the trigger device is on or off, the script runs upon screen switching or other applicable processes.
Example) When a screen script ([Trigger Type]: [Rise], [Trigger Device]: X1000) is set for base screen 2
After base screen 1 is switched to base screen 2, if the trigger device (X1000) turns on, the screen script set for base 
screen 2 is executed.

The following processes trigger applicable scripts to run.

(a) Project script
• When the GOT is powered on or when the GOT returns from offline

(b) Screen script
• Screen switching

The script set for the destination screen runs upon screen switching.
If [Perform script initial operation (screen/object) only when switching screens] is deselected in the [Script] dialog, each 
of the following processes triggers the relevant script to run.

➟9.9.5 ■4 [Option] tab
• Security switching
• Language switching
• System language switching
• Station No. switching

When the station No. switching devices are set by screen type, the scripts that are set for the screens of the target 
screen type are executed.

• Offset switching
Only the screen scripts are executed.
On a screen having a script setting, when offset switching occurs in any device of the screen, the script is executed.

• Buffer memory unit No. switching
• When object script "redraw_screen()" is executed

(4) Object Script Common Control (GS387)
Notifies the information common to object scripts.
• b0: When this bit is turned on, the object script error records are cleared as shown below.

GS80.b0, b7, b8, and b12 store 0.
GS81 stores -1.
GS82 to GS113 store 0.

• b1: When this bit is turned on, the object script aborted due to an error is re-executed.
• b2 to b15: Use prohibited
For the precautions on the object script error, refer to the following.

➟9.10.7 ■1 (10) Object script error control and GOT status

(5) Object Script Monitoring Time (GS388)
Specify the monitoring time of an object script in seconds.
If a script does not end after a lapse of the specified time, the script is aborted.
The setting range is [1] (second) to [300] (seconds).
If an invalid value is specified, 10 seconds are assumed.

(6) Object Script Initial Operation (GS389)
Set whether to run an object script upon screen switching or others applicable processes.
• When GS389 stores 0, the object script runs.
• When GS389 stores a nonzero value, the object script does not run.
This setting is applied to the object scripts where the following trigger types are set.
• [Rise]:

Screen switching

Trigger device
(X1000)

Screen Switching
device

When GS386 stores 0, the script is executed.

ON

OFF

1 2
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When the trigger device is on, the script runs upon screen switching or other applicable processes.
• [Fall]:
When the trigger device is off, the script runs upon screen switching or other applicable processes.

• [Rise/Fall]:
When the trigger device is on or off, the script runs upon screen switching or other applicable processes.

Example) When the object script ([Trigger Type]: [Rise], [Trigger Device]: X1000) is set for a switch on base screen 2
After base screen 1 is switched to base screen 2, if the trigger device (X1000) turns on, the object script of the switch on 
base screen 2 is executed.

The following processes trigger applicable scripts to run.
• Screen switching
The script set for the destination screen runs upon screen switching.

If [Perform script initial operation (screen/object) only when switching screens] is deselected in the [Script] dialog, each 
of the following processes triggers the relevant script to run.

➟9.9.5 ■4 [Option] tab
• Security switching
• Language switching
• System language switching
• Station No. switching
When the station No. switching devices are set by screen type, the scripts that are set for the screens of the target screen 
type are executed.

(7) File Operation Data Storage Order (GS390)
The following script types are supported: project script, screen script, and script part.
Select the order in which data is stored when using the file_read or file_write function in a script.
[Low-->High]: Stores data from the lower-order bytes.
[High-->Low]: Stores data from the higher-order bytes.
Alternatively, you can configure the data storage order setting on GT Designer3.
This setting becomes invalid when GS390 stores 1 or 2.
The following shows examples of settings.
• When GS390 stores 0, data is stored in the order specified on GT Designer3.
• When GS390 stores 1, data is stored from the lower-order bytes.
• When GS390 stores 2, data is stored from the higher-order bytes.
• When GS390 stores 3 or more, data is stored in the order specified on GT Designer3.

(8) Start GD Device for Script Error Info Notification (GS392)
The following script types are supported: project script, screen script, and script part.
Specify the start device number of the GD devices to store error records.
Data type: Unsigned binary

Screen switching

Trigger device
(X1000)

Screen Switching
device

When GS389 stores 0, the script is executed.

ON

OFF

1 2
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(9) Number of Script Error Info Outputs (GS394)
The following script types are supported: project script, screen script, and script part.
Specify the maximum number of error records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no error record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS395.b1 specifies the operation to be performed when the number of errors has exceeded the maximum number of 
error records.
The following shows an example of how an error record is stored in eight word devices starting from GD1000.

(10)Script Error Info Output Common Control (GS395)
The following script types are supported: project script, screen script, and script part.
• b0: When this bit is turned on, storing error records starts.
When this bit is turned off, storing error records ends.

• b1: Specifies the operation to be performed when the number of errors has exceeded the maximum number of error 
records specified with GS394.
When this bit is turned on, storing error records stops.
When this bit is turned off, storing error records continues by overwriting the oldest record.

• b2 to b7: Use prohibited
• b8: When this bit is turned on, the project script error records are not stored.
• b9: When this bit is turned on, the screen script error records are not stored.

Storage device Item Description

GD1000 Error code
Error code of an error.
For the error details and corrective actions, refer to the following.

➟9.9.14 ■3 (5) List of script execution error codes

GD1001 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 1: Project script
• 2: Screen script (set for a base screen)
• 3: Screen script (set for a window screen)
• 4: Script part

GD1002 Screen number
Number of the screen for which the script is set.
The device stores 0 for a project script.

GD1003 Script number or object ID number

The device stores a script number or object ID number according to the 
script type.
• For project scripts and screen scripts: script number
• For script parts: object ID number

GD1004 Execution order number

Script execution order number specified on GT Designer3
The device stores any of the following values according to the script type.
• For project scripts: 1 to 256
• For screen scripts: 1 to 256 (per screen)
• For script parts: 1 to 16 (per script parts object)

GD1005 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen 
type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
If the script is set for a called screen, the device stores a value by adding 
a number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332
The device stores 0 for a project script.

GD1006 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1007 Use prohibited The device stores 0.
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• b10: When this bit is turned on, the script error records of script parts objects are not stored.
• b11: When this bit is turned on, the records of warnings that do not abort a script are not stored.
• b12 to b15: Use prohibited

(11)Start GD Device for Script Event Notification (GS396)
The following script types are supported: project script, screen script, and script part.
Specify the start device number of the GD devices to store script execution records.
Data type: Unsigned binary

(12)Number of Script Event Outputs (GS398)
The following script types are supported: project script, screen script, and script part.
Specify the maximum number of script execution records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no script execution record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS399.b1 specifies the operation to be performed when the number of the executed scripts has exceeded the maximum 
number of script execution records.
The following shows an example of how a script execution record is stored in eight word devices starting from GD1000.

(13)Script Event Output Common Control (GS399)
The following script types are supported: project script, screen script, and script part.
• b0: When this bit is turned on, storing script execution records starts.
When this bit is turned off, storing script execution records ends.

• b1: Specifies the operation to be performed when the number of executed scripts has exceeded the maximum number 

Storage device Item Description

GD1000 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 1: Project script
• 2: Screen script (set for a base screen)
• 3: Screen script (set for a window screen)
• 4: Script part

GD1001 Screen number
Number of the screen for which the script is set.
The device stores 0 for a project script.

GD1002 Script number or object ID number

The device stores a script number or object ID number according to the 
script type.
• For project scripts and screen scripts: script number
• For script parts: object ID number

GD1003 Execution order number

Script execution order number specified on GT Designer3
The device stores any of the following values according to the script type.
• For project scripts: 1 to 256
• For screen scripts: 1 to 256 (per screen)
• For script parts: 1 to 16 (per script parts object)

GD1004 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen 
type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
If the script is set for a called screen, the device stores a value by adding 
a number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332
The device stores 0 for a project script.

GD1005 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1006 Use prohibited The device stores 0.

GD1007 Use prohibited The device stores 0.
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of script execution records specified with GS398.
When this bit is turned on, storing script execution records stops.
When this bit is turned off, storing script execution records continues by overwriting the oldest record.

• b2 to b7: Use prohibited
• b8: When this bit is turned on, the project script execution records are not stored.
• b9: When this bit is turned on, the screen script execution records are not stored.
• b10: When this bit is turned on, the script execution records of script parts objects are not stored.
• b11 to b15: Use prohibited

(14)Gateway Common Control (GS400)
Controls the FTP server function.
GT21 and GS21 support b2 and b8.
• b0 to b1: Use prohibited
• b2: When this bit is turned on, all FTP clients connected to the FTP server are forcibly disconnected.
• b3 to b7: Use prohibited
• b8: When this bit is turned on, binary files (*.G2□) become readable from all the FTP clients that are connected to the 
FTP server.

• b9 to b10: Use prohibited
• b11: When this bit is turned on, the error occurring in the mail send function is cleared. (GS200.b11 and GS201 to 
GS206 are cleared.)

• b12 to b13: Use prohibited
• b14: When this bit is turned on, the error occurring in the server function is cleared. (GS200.b14 and GS210 to GS216 
are cleared.)

• b15: When this bit is turned on, the error occurring in the client function is cleared. (GS200.b15 and GS220 to GS226 
are cleared.)

(15)File Transfer Control (GS401)
• b0: When this bit is turned on, the error code stored in the following device is cleared or the following signals are turned 
off.
File Transfer Error No. (GS989)
Warning signal (GS990.b14)
File Transfer Error signal (GS990.b15)

• b1 to b15: Use prohibited

(16)File Transfer Timeout Time (GS402)
Set the timeout period for FTP communication in units of seconds.
If a script does not end after the lapse of the timeout period, the script processing is aborted.
The setting range is [1] (second) to [300] (seconds).
If the set value falls outside the setting range, the timeout period defaults to 3 seconds.

(17)Maximum Number of Connected FTP Clients (GS404)
Specify the number of FTP clients connectable to the FTP server.
The setting range is 1 to 4.
If an invalid value is specified, 1 is assumed.
Changing the number of connectable FTP clients does not affect the already-connected FTP clients.

(18)GOT Information Output Common Control (GS405)
For GT2505-V and GT25HS-V, b0 and b1 are available.
• b0: When this bit is turned on, the GOT serial number is output to the devices specified with GS406.
If 10 word devices cannot be reserved, the output is not executed.

• b1: When this bit is turned on, the MAC address of the Ethernet standard port or Ethernet standard port 1 is output to 
the devices specified with GS408.
If 3 word devices cannot be reserved, the output is not executed.

• b2: When this bit is turned on, the MAC address of the Ethernet extended port or Ethernet standard port 2 is output to 
the devices specified with GS410.
If 3 word devices cannot be reserved, the output is not executed.

• b3: When this bit is turned on, the MAC address of the wireless LAN interface is output to the devices specified with 
GS412.
If 3 word devices cannot be reserved, the output is not executed.
The output may not be executed upon startup of the GOT, and therefore check that the Wireless LAN Status Notification 
signal (GS1060.b0) is on and then execute the output.
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• b4 to b15: Use prohibited

(19)Serial No. Output Destination (GS406)
Specify the start device number of the GOT data registers (GD) to store the GOT serial number.
Ten GD devices, starting from the specified device, are used to store the GOT serial number.

(20)Ethernet Port 1 MAC Address Destination (GS408)
Specify the start device number of the GOT data registers (GD) to store the MAC address of the Ethernet standard port 
or Ethernet standard port 1.
Three GD devices, starting from the specified device, are used to store the MAC address.

(21)Ethernet Port 2 MAC Address Destination (GS410)
Not available to GT2505-V and GT25HS-V.
Specify the start device number of the GOT data registers (GD) to store the MAC address of the Ethernet extended port 
or Ethernet standard port 2.
Three GD devices, starting from the specified device, are used to store the MAC address.

(22)Wireless LAN Interface MAC Address Destination (GS412)
Not available to GT2505-V and GT25HS-V.
Specify the start device number of the GOT data registers (GD) to store the MAC address of the wireless LAN interface.
Three GD devices, starting from the specified device, are used to store the MAC address.

(23)Current Directory Designation when Logging in to the FTP Server Function (GS423)
Specify the current directory when logging in to the FTP server.
• b0 to b9: Use prohibited
• b10: When this bit is turned on, drive V is specified as the current directory.
• b11 to b15: Use prohibited

(24)Start GD Device for Object Script Error Info Notification (GS432)
Specify the start device number of the GD devices to store error records.
Data type: Unsigned binary

(25)Number of Object Script Error Info Outputs (GS434)
Specify the maximum number of error records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no error record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS435.b1 specifies the operation to be performed when the number of errors has exceeded the maximum number of 
error records.
The following shows an example of how an error record is stored in eight word devices starting from GD1000.

Storage device Item Description

GD1000 Error code
Error code of an error.
For the error details and corrective actions, refer to the following.

➟9.10.9 ■3 (5) List of object script execution error codes

GD1001 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 10: Display object script or switch object script
• 11: Input object script

GD1002 Screen number Number of the screen where the object is placed.

GD1003 Object ID number ID number of the object where a script error has occurred.

GD1004 Use prohibited The device stores 0.
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(26)Object Script Error Info Output Common Control (GS435)
• b0: When this bit is turned on, storing error records starts.
When this bit is turned off, storing error records ends.

• b1: Specifies the operation to be performed when the number of errors has exceeded the maximum number of error 
records specified with GS434.
When this bit is turned on, storing error records stops.
When this bit is turned off, storing error records continues by overwriting the oldest record.

• b2 to b10: Use prohibited
• b11: When this bit is turned on, the records of warnings that do not abort a script are not stored.
• b12 to b15: Use prohibited

(27)Start GD Device for Object Script Event Notification (GS436)
Specify the start device number of the GD devices to store script execution records.
Data type: Unsigned binary

(28)Number of Object Script Event Outputs (GS438)
Specify the maximum number of script execution records.
Data type: Unsigned binary
The setting range is 0 to 5000.
If the device stores 0, no script execution record will be stored.
If the device stores 5001 or more, up to 5000 records will be stored.
GS439.b1 specifies the operation to be performed when the number of the executed scripts has exceeded the maximum 
number of script execution records.
The following shows an example of how a script execution record is stored in eight word devices starting from GD1000.

GD1005 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen 
type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
• 400: User-created key window
• 500: Dialog window substituted for a system message
If the script is set for a called screen, the device stores a value by adding 
a number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332

GD1006 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1007 Use prohibited The device stores 0.

Storage device Item Description

Storage device Item Description

GD1000 Script type

Number that shows a script type.
The device stores any of the following values according to the script type.
• 10: Display object script or switch object script
• 11: Input object script

GD1001 Screen number Number of the screen where the object is placed.

GD1002 Object ID number ID number of the object where a script error has occurred.

GD1003 Use prohibited The device stores 0.
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(29)Object Script Event Output Common Control (GS439)
• b0: When this bit is turned on, storing script execution records starts.
When this bit is turned off, storing script execution records ends.

• b1: Specifies the operation to be performed when the number of executed scripts has exceeded the maximum number 
of script execution records specified with GS438.
When this bit is turned on, storing script execution records stops.
When this bit is turned off, storing script execution records continues by overwriting the oldest record.

• b2 to b15: Use prohibited

(30)Exclusive Authorization Control (GS447)
Controls the authorization of the SoftGOT-GOT link function.
This is disabled when the GOT network interaction function is used.
• b0: When this bit is turned on, the GOT obtains the exclusive authorization.
• b1: When this bit is turned on, the authorization guarantee time for the SoftGOT-GOT link function is disabled and 
GS984 (Authorization Guarantee Status Notification signal) stores 0.

• b2 to b15: Use prohibited

(31)RGB Display Common Control (GS449)
• b0: When this bit is turned on, the RGB screen is displayed at the center of the GOT screen .
When this bit is turned off, the RGB screen is displayed at position set by the RGB display position (b13) of [Video/RGB 
Input Common] device.

➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device
• b1 to b15: Use prohibited

(32)Monitor Common Control (GS450)
GT21 (except GT2107-W) and GS21 support b15 only.
GS21-W-N supports b4.
GT2107-W supports b4 and b15.

• b0: When this bit is turned on, a confirm message is displayed after numerical or text data (numerical input or text 
input) is input .

• b1: Controls the displaying methods of the message displayed when an numeric value exceeding the valid range is 
input.
Turning on displays a message during the numerical input.
Turning off displays a message after the numeric value is input.

• b2: When this bit is turned on, the system signal 1-1.b4 (Numeric Value Input Read Complete signal), system signal 
2-1.b4 (Numeric Value Input signal), [Numeric Value Input Number], [Current Cursor Display User ID], and [Previous 
Cursor Display User ID] in the [Environmental Setting] window ([System Information]) are activated during the input 
as well.

• b3: When this bit is turned on, 0 is stored into [Current Cursor Display Object], [Previous Cursor Display Object], 

GD1004 Screen type

Type of the screen for which the script is set.
The device stores any of the following values according to the screen 
type.
• 200: Base screen
• 210: Superimpose window 1
• 220: Superimpose window 2
• 310: Overlap window 1
• 320: Overlap window 2
• 330: Overlap window 3
• 340: Overlap window 4
• 350: Overlap window 5
• 400: User-created key window
• 500: Dialog window substituted for a system message
If the script is set for a called screen, the device stores a value by adding 
a number to the number showing the calling screen type.
• When a base screen is called, 1 is added.
• When a window screen is called, 2 is added.
Example) When a window screen is called from overlap window 3
330 + 2 = 332

GD1005 Number of the displayed base screen Number of the base screen that is displayed when the script runs.

GD1006 Use prohibited The device stores 0.

GD1007 Use prohibited The device stores 0.

Storage device Item Description
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[Current Cursor Display User ID], and [Previous Cursor Display User ID] in the [Environmental Setting] window 
([System information]) when a cursor is erased.

• b4: When this bit is turned on, the Kana-Kanji conversion or Pinyin conversion function is activated when text input 
is used.
The conversion function selected for [Kana-Kanji/Pinyin Conversion] in the [Environmental Setting] window ([Kana-
Kanji/Pinyin Conversion]) is activated.

• b5: When this bit is turned on, the key window is forcibly closed if the input condition (the trigger condition or security 
level for the object) is not satisfied during a value or text input.

• b6: When this bit is turned on, the key window for inputting binary values is displayed for the numerical input whose 
format is binary.

• b7: When this bit is turned on, the key window for inputting octal values is displayed for the numerical input whose 
format is octal.

• b8: When this bit is turned on, BNP, JPE, and PNG files in the data storage can be used as a part for parts display 
or parts movement.
Turning off displays parts registered by GT Designer3.
When [Show image files in the memory card at the time of specifying Parts No. 9001-9999] is selected in the [Parts 
Setting] dialog, a BMP, JPEG, or PNG file in the data storage is used as a part regardless of the on and off status of 
this signal.

➟8.8 Placing a Parts Display
• b9: When this bit is turned on, the GOT retains the state of the historical trend graph displayed before screen 

switching and displays the same graph state after switching back to the graph screen.
➟8.21 Placing a Historical Trend Graph

• b10: When this bit is turned on, the upper and lower limit symbols on the trend graph and the historical trend graph 
are hidden.

• b11: Use prohibited
• b12: Controlling the timing when the bit alternate or bit reset, or bit reset, or screen switching and station No. 

switching are set to the touch switch.
➟8.2 Placing a Touch Switch

• b13: When this bit is turned on, the data storage stores the history of the screen switching.
• b14: When this bit is turned on, the screen switching mode is switched from the previous mode to the history mode.
• b15: While this bit is on, touching an alarm once in the alarm display (user) displays the detail screen.

While this bit is off, touching an alarm twice in the alarm display (user) displays the detail screen.

(33)Auto Screen Save Time (GS451)
Stores the time before closing (OFF) the monitor screen in screen save function.
Stores the value by 1 to 60 (Min).
(To store value higher than 60, store it as 60)
The changed value is validated after canceling the screen save when a value is changed during the screen save.

Relationship between GS451 and GOT utility (screen save time)
If value other than 0 is stored in GS451, the screen save time set in GOT utility will be invalidated.
To validate the screen save time of utility, store 0 in GS451.

Error date and time Comment

04/5/1 Fuse error
04/5/1 Oil error

04/5/1 Temperature anomaly

When GS450.b15 is on

Touch an alarm.

Error date and time Comment

04/5/1 Fuse error
04/5/1 Oil error

04/5/1 Temperature anomaly

When GS450.b15 is off

Touch an alarm to select it.
Error date and time Comment

04/5/1 Fuse error
04/5/1 Oil error

04/5/1 Temperature anomaly

Touch the selected alarm again.

Error date and time Comment

04/5/1 Fuse error
04/5/1 Oil error

04/5/1 Temperature anomalyA temperature anomaly has 
occurred in the power supply unit.
Check the power supply unit.

The detail screen 
is displayed.

Error date and time Comment

04/5/1 Fuse error
04/5/1 Oil error

04/5/1 Temperature anomalyA temperature anomaly has 
occurred in the power supply unit.
Check the power supply unit.

The detail screen 
is displayed.
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(34)Ethernet Port 1 Access Control, Ethernet Port 2 Access Control (GS454)
Controls the operations through an Ethernet network.
The Ethernet interface corresponding to each bit varies by GOT model.
The following shows the correspondence between the Ethernet interfaces and the bits.

• b0: Turn on this bit to disable the writing of package data (containing system applications) through the corresponding 
Ethernet interface.

• b1: Turn on this bit to disable the writing of package data (containing project data) through the corresponding Ethernet 
interface.

• b2 and b3: Use prohibited
• b4: Turn on this bit to disable the writing of package data (containing system applications) through the corresponding 

Ethernet interface.
• b5: Turn on this bit to disable the writing of package data (containing project data) through the corresponding Ethernet 

interface.
• b6 and b7: Use prohibited
• b8: Turn on this bit to disable the reading of data through the corresponding Ethernet interface.
• b9 to b11: Use prohibited
• b12: Turn on this bit to disable the reading of data through the corresponding Ethernet interface.
• b13 to b15: Use prohibited

(35)Intensity Control (GS455)
Sets the intensity and the brightness adjustment mode of the GOT display section.
• b0 to b14: When the bits store a setting value, the intensity of the backlight changes to the one corresponding to the 
setting value.
The setting value ranges from 1 to 8, or 101 to 132.

For GT23

If 0 and 9 to 100, or 133 or more is set, the setting for the intensity adjustment function for the utility is applied.
• b15: When the bit turns on, the brightness adjustment mode is set to the low intensity.
To set the brightness adjustment mode to the low intensity, install the version E or later of BootOS on the GOT.

The intensity of the GOT can be confirmed by the Intensity Notification (GS255).

GOT Ethernet interface Bit number

GT27, GT25-S, 
GT25-V (excluding 
GT2505-V)

Ethernet standard port b0, b1, b8

Ethernet extended port b4, b5, b12

GT25-W, GS25
Ethernet standard port 1 b0, b1, b8

Ethernet standard port 2 b4, b5, b12

GT2505-V, 
GT25HS-V, GT23, 
GT21, GS21

Ethernet standard port b0, b1, b8

Intensity Setting value Intensity Setting value Intensity Setting value Intensity Setting value

1 1 or 101 9 109 17 117 25 125

2 102 10 3 or 110 18 118 26 126

3 103 11 111 19 5 or 119 27 127

4 104 12 112 20 120 28 7 or 128

5 2 or 105 13 113 21 121 29 129

6 106 14 4 or 114 22 122 30 130

7 107 15 115 23 6 or 123 31 131

8 108 16 116 24 124 32 8 or 132

Intensity Setting value Intensity Setting value Intensity Setting value Intensity Setting value

1 102 5 3 or 110 9 118 13 126

2 104 6 112 10 120 14 7 or 128

3 106 7 4 or 114 11 122 15 130

4 108 8 116 12 124 16 8 or 132
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➟12.1.3 ■2 (49) Intensity Notification (GS255)
For the specifications of the GOT display section, refer to the following.

➟GOT2000 Series User's Manual (Hardware)

(1) Setting value changed by the Intensity Control (GS455)
The Intensity Control (GS455) changes the setting value of the intensity temporarily.
If the GOT is turned off after the setting value is changed by the Intensity Control (GS455), the value is 
returned to the value set in the utility.

(2) Stored setting value
For the projects converted from GOT1000 projects, you can use the stored setting value without 
changing the Intensity Control (GS455) setting.
Since the intensity is controlled in eight levels, the setting value ranges from 1 to 8.

(36)Character Code Control (GS456)
The character code used for the text display or the text input is changeable.
This device is enabled only when the character code is determined by the system language or Unicode.
If you change the character code, the KANJI region for the kanji characters displayed on the text display or the text input 
is also changed.
The character code is changed to one corresponding to the stored value as shown below.

*1 This item is enabled when all of the following conditions are satisfied.
• Selecting [Kana-Kanji/Pinyin Conversion] in the [Extended] tab in the [Text Input] dialog
• Selecting [Pinyin Simplified Characters] for [Conversion Method] in [GOT Environmental Setting] → [Kana-Kanji/Pinyin 

Conversion]
For the GOT models other than GT21 and GS21, a new character code is reflected to the GOT screen at any of the 
following timing.
• Switching screens (Switching to a key window or dialog window is excluded.)
• Switching security levels or operator accounts
• Switching languages
• Switching station numbers
• Switching buffer memory unit numbers
• Executing the function (redraw_screen()) of the object script

For GT21 and GS21, a new character code is reflected to the GOT screen in real time.

(a) Applied KANJI region
If the GOT does not have a font corresponding to the KANJI region for a selected character code, the KANJI region for the 
standard font is applied.
The following is an example in using the GOT that has only Japanese as the standard font (standard).
If the character code is changed to GB code, the KANJI region of the displayed kanji characters is set to Japanese.

(b) How to reflect the new setting at the GOT startup
You can reflect the new setting at the GOT startup by using the object script.

Example) When changing the character code to GB code at the GOT startup
On the screen displayed at the GOT startup, place an object where the following object script is set.

Stored 
value Character code KANJI region of displayed kanji characters Supported 

models

0
ASCII code, Shift JIS code Japanese

GB code*1 Chinese (Simplified)

1 Shift JIS code Japanese

2 ASCII code Japanese

3 GB code Chinese (Simplified)

4 KS code Japanese

5 BIG5 Chinese (Traditional)

Setting item for the script Setting details

Trigger type [Rise]

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(37)Pass-through Transparent Stop Control (GS457)
When 1 is set at this area, pass-through transparent stop request is performed.
By using this area, the user can expedite recovery from the pass-through transparent recovery waiting status.
This area is effective only when 2 (pass-through mode in operation) is set for FA transparent status (GS256).
0: No stop request
1: No stop request

(38)Conversion Start Indication (GS460)
The following script types are supported: project script, screen script, and script part.
• b0: With Integer←→Real Number Conversion, converting unsigned 16-bit binary data to real numbers is specified.
• b1: With Integer←→Real Number Conversion, converting signed 16-bit binary data to real numbers is specified.
• b2 and b3: Use prohibited
• b4: With Integer←→Real Number Conversion, converting real numbers to unsigned 16-bit binary data is specified.
• b5: With Integer←→Real Number Conversion, converting real numbers to signed 16-bit binary data is specified.
• b6 to b14: Use prohibited
• b15: With Integer←→Real Number Conversion, the conversion start is indicated.

(39)Number of Conversion Devices (GS461)
The following script types are supported: project script, screen script, and script part.
With Integer←→Real Number Conversion, the number of conversion devices is specified.
1 to 4096 conversion devices can be specified.

(40)Conversion Source Head Device No. (GS462)
The following script types are supported: project script, screen script, and script part.
With Integer←→Real Number Conversion, the head device No. of GOT internal device (GD) that stores the value before 
conversion is specified.

(41)Conversion Destination Head Device No. (GS463)
The following script types are supported: project script, screen script, and script part.
With Integer←→Real Number Conversion, the value after conversion is stored and the head device No. of GOT internal 
device (GD) is specified.

(42)Storage Error Value (GS464)
The following script types are supported: project script, screen script, and script part.
With Integer←→Real Number Conversion, if conversion error occurs, the device value to be stored in the conversion 
destination device is specified.

(43)Remote Personal Computer Operation (Ethernet) Common Control (GS465)
Set whether to display the operation buttons on the personal computer screen on the GOT, and specify the display 
magnification of the personal computer screen.
The setting is applied when the GOT displays the personal computer screen with the remote personal computer operation 
function (Ethernet).
For the details of the remote personal computer operation function (Ethernet), refer to the following.

➟10.3 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation (Ethernet))
• b0: When this bit is turned on, the [CAD] button is hidden.
• b1: When this bit is turned on, the [C+E] button is hidden.
• b2: When this bit is turned on, the [KBD] button is hidden.
• b3: When this bit is turned on, the zoom in button and the zoom out button are hidden.
• b4: Use prohibited
• b5: Specifies the display magnification of the personal computer screen to be applied when b3 is turned on.
When this bit is turned on, the display magnification specified on GT Designer3 is applied.
When this bit is turned off, the display magnification is fixed to 100%.

• b6: When this bit is turned on, the click switching button is hidden.
• b7: When this bit is turned on, the scroll bars of the personal computer screen on the GOT are hidden.
• b8: When this bit is turned on, the personal computer screen on the GOT opens in the full screen mode.
For the display modes of the personal computer screen on the GOT, refer to the following.

Trigger device GS0.b4 (Common Information1: Always ON signal)

Script
[w:GS456] = 3;
redraw_screen();

Setting item for the script Setting details
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➟10.3.2 ■5 Display modes of the personal computer screen on the GOT
• b9: When this bit is on, the GOT (VNC server) can be connected to a vision sensor described in the following Technical 
Bulletin.

➟List of VNC Servers Supporting the Remote Personal Computer Operation (Ethernet) Function Validated to 
Operate with the GOT2000 Series (GOT-A-0110)

• b10: When the GOT connected with multiple personal computers displays a remote screen window, use this bit to set 
the action when the touch screen to open the specified personal computer screen without closing the remote screen 
window is touched.
When this bit is on, the personal computer screen on the GOT is switched.
When this bit is off, the personal computer screen on the GOT is not switched and an error message is displayed.
For switching the personal computer screen on the GOT, refer to the following.

➟10.3.2 ■6 Switching the personal computer screen on the GOT
• b11 to b15: Use prohibited

(44)Unit of Drive Free Space (GS466)
Specify the unit of values to be stored in the Drive Empty Capacity Information devices of the system information.

➟5.2.5 ■1 (14) Drive Empty Capacity Information
This setting applies to all the drives when the system information is updated.
The setting range is 0 to 2.
If you set a value outside the setting range, each target device stores a value in bytes.

If you change the specified unit, the maximum size of free space to be notified is changed. Note that the capacity of the 
data storage usable in the GOT remains unchanged.

(45)Monitor Common Control 2 (GS467)
• b0: When this bit is turned on, the cursor moves to a different alarm on the alarm display (user) after the alarm under 

the cursor is deleted.
The cursor display position after the deletion varies with the displayed contents on the alarm display (user).
If an alarm is displayed below the deleted alarm, the cursor moves to this alarm after the deletion.
If all the other alarms are displayed above the deleted alarm, the cursor moves to the alarm at the bottom after the 
deletion.
If all the alarms are deleted, the cursor is hidden after the deletion.
When this bit is off, the cursor is hidden.

• b1: When this bit is turned on, a key window for text input that supports Kana-Kanji conversion or Pinyin conversion 
appears when a text input object with Kana-Kanji/Pinyin conversion enabled is touched.
The conversion function selected for [Kana-Kanji/Pinyin Conversion] in the [Environmental Setting] window ([Kana-
Kanji/Pinyin Conversion]) is activated.

• b2 to b15: Use prohibited

Stored value Unit Remarks

0 byte Each target device notifies up to 2 GB free space.

1 Kbyte

Each target device notifies up to 2 TB free space.
(1 Kbyte = 1024 bytes)
The fractional portion is rounded off.
Example) For 1.1 Kbytes of free space, 1 is stored.

2 Mbyte

Each target device notifies up to 2 PB free space.
(1 Mbyte = 1024 Kbytes)
The fractional portion is rounded off.
Example) For 1.2 Mbytes of free space, 1 is stored.
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(46)Kanji Region Control (GS468)
The KANJI region used for the text display or text input is changeable.
This setting is applied to all the text displays and text inputs where [Character Code] is set to [Unicode].
The KANJI region is changed according to the stored value as shown below.

For the GOT models other than GT21 and GS21, a new KANJI region is reflected to the GOT screen at any of the 
following timing.

• Switching screens (Switching to a key window or dialog window is excluded.)
• Switching security levels or operator accounts
• Switching languages
• Switching station numbers
• Switching buffer memory unit numbers
• Executing the function (redraw_screen()) of the object script

For GT21 and GS21, a new KANJI region is reflected to the GOT screen in real time.

If the GOT has no font corresponding to the new KANJI region, the KANJI region for an installed standard font is applied.

(a) How to reflect the new setting at the GOT startup
You can reflect the new setting at the GOT startup by using the object script.

Example) When changing the KANJI region to Simplified Chinese at the GOT startup
On the screen displayed at the GOT startup, place an object where the following object script is set.

(47)GT SoftGOT2000 Common Control (GS500)
• b0: When this bit is turned on, the dialog for exiting the GT SoftGOT2000 is displayed.
If exiting is canceled in the displayed dialog, the signal turns off.

• b1: When this bit is turned on, GT SoftGOT2000 is displayed in the full screen mode.
When this bit is turned off, the full screen mode of GT SoftGOT2000 is canceled.

• b2: When this bit is turned on, the [File Information in PLC] dialog is displayed.
Not available to GT SoftGOT2000 (Multiple channels).

• b3 to b15: Use prohibited

(48)Application Start signal (GS501, GS502)
b0 to b15: When this bit is turned on, the application assigned to each bit by GT SoftGOT2000 runs.

(49)GT SoftGOT2000 Full Screen Size (Width) (GS503)
With the full screen mode function of GT SoftGOT2000, set the width of GT SoftGOT2000 monitor screen (320 to 1920 
dots).
When the set value is 320 or less, the value is processed as 320. When the set value is 1920 or more, the value is 
processed as 1920.

(50)GT SoftGOT2000 Full Screen Size (Height) (GS504)
With the full screen mode function of GT SoftGOT2000, set the height of GT SoftGOT2000 monitor screen (240 to 1200 
dots).
When the set value is 240 or less, the value is processed as 240. When the set value is 1200 or more, the value is 
processed as 1200.

Stored value KANJI region

0 Not changed

1 Japanese

2 Simplified Chinese

3 Traditional Chinese

Setting item for the script Setting details

Trigger type [Rise]

Trigger device GS0.b4 (Common Information1: Always ON signal)

Script
[w:GS468] = 2;
redraw_screen();
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(51)Advanced Application Start signal (GS505, GS506 to GS507)
Using a value in GS505 and any bit from GS506 to GS507 starts an application on GT SoftGOT2000.
For setting the devices from GS505 to 507 as a trigger of the application, refer to the following manual.

➟GT SoftGOT2000 Version1 Operating Manual

(a) GS505
Stores a value used for starting the application. (1 to 255)

(b) GS506 to 507
b0 to b15: When this bit is turned on, the application assigned to each bit according to a value stored in GS505.

(52)Device Data Transfer Information (GS510)
• b0: When this bit is turned on, the device stores 0 in the Error Device Data Transfer ID (GS642) and the Device Data 
Transfer Error Count (GS643).

• b1: When this bit is turned on, the device stores 0 in the Device Data Transfer Processing Time (GS644), the Device 
Data Transfer Min. Processing Time (GS646), and the Device Data Transfer Max. Processing Time (GS648).

• b2 to b15: Use prohibited

(53)Touch Status Communication Control (GS511)
• b0: When this bit is turned on, the touch status is output to the personal computer.
When this bit is turned off, the touch status is not output to the personal computer.

• b1 to b15: Use prohibited

For using the Touch Status Communication Control
To use the Touch Status Communication Control, the system application (extended function) for the remote 
personal computer operation (Serial) is required.
For details of the remote personal computer operation (Serial), refer to the following.

➟10.4 Operating a Personal Computer by Using the GOT (Remote Personal Computer Operation 
(Serial))

(54)Time Change Information (GS512)
• b0: When this bit is turned on, the GOT clock data is changed to the data set for the Changed Time (GS513 to GS516).
• b1 to b15: Use prohibited

(55)Changed Time (GS513 to GS516)
Stores the current time with BCD code.
The valid date range varies with the GOT model.
• GT27, GT25, GT23, and GS25: Jan. 1, 2000 to Dec. 31, 2099
• GT21 and GS21: Jan. 1, 2000 to Dec. 31, 2037
The day-of-the-week data, 0 to 6, is stored.
(0: Sunday 1: Monday 2: Tuesday 3: Wednesday 4: Thursday 5: Friday 6: Saturday)
Example) When the error occurrence date is 15:30:20 May 15, 2013 (Wednesday)

(56)External I/O Function Notification/External I/O Control Function (GS517)
• b0: When this bit is turned on, the 128-point input can be executed with the external I/O function.
When this bit is turned off, the 16-point input can be executed.

• b1 to b15: Use prohibited

128-point input
Without the 128-point input (when the above device turns off), the GOT internal device turns on when the 
16-point input is executed with the input terminal.
With the 128-point input (when the above device turns on), the 16-point input with the input terminal is used 

GS513

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GS514

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GS515

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GS516

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Error occurrence date: 2013 / 5 / 15   15:30:20 (3: Wednesday) (Binary Coded Decimal)
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with the 8-point scan signal and the 128-point input (16 × 8) is performed.
For connection diagrams of each signal with the external I/O function, refer to the following manual.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) 
For GT Works3 Version1

(57)Sound Output Common Control (GS518)
• b0: Turn on this bit to stop the current playback.
• b1: Turn on this bit to stop the current playback and cancel all standby sound files.
• b2: Turn on this bit to mute the sound.
• b3 to b15: Use prohibited

(58)Buffering And File Access Control (GS520)
• b0: When this bit is turned on, the whole data in the buffering area is stored in the destination drive at the timing of the 
rising edge.

• b1 to b15: Use prohibited

(59)Trigger Backup Data Send Delay (GS521)
The backup/restore function can set the delay time for backup communication intervals.
Setting of the delay time can reduce the load of other processes (such as monitoring objects) with the backup process.
The delay time set by the set value is listed as follows.

Setting of Trigger Backup Data Send Delay
Backup communication times are longer than a default when the Trigger Backup Data Send Delay is set.
Set the suitable delay time to match the processing condition of backup function and others (such as 
monitoring objects).

(60)Special Control During Specific Function Execution (GS522)
GT25, GT23, and GS25 support b0, b2 to b4, and b6.
GT2105-Q, GT2104-R, GT2104-P, GT2103-P, and GS21-W support b2 only.
GT2107-W and GS21-W-N support b2 and b3.
GT SoftGOT2000 supports b0, b2, and b3.
• b0: When this bit is turned on, during the backup/restore function execution, processing by the alarm functions, the 
logging function, and others and device monitoring stop, and only the backup and restore process is executed.

• b1: When this bit is turned on, the GOT notifies the amount of usage of the CF card and the number of video files in the 
card in the multimedia unit by using the Video File Maintenance Information (GS1022).
This function is usable only when [Enable] is selected and [Event Trigger Device] is set in [Before-After Event Recording 
Setting] on the [Recording Setting] tab of the [Multimedia] dialog.

➟12.1.3 ■3 (39) Video File Maintenance Information (GS1022)
• b2: When this bit is on, the character code is changed to Unicode and data is tab-delimited during a binary-to-CSV 
conversion or the creation of a CSV file.
Turn on this bit before executing the following operations.
· Converting a binary file (alarm log file, logging file, recipe file, or operation log file) to a CSV file
· Outputting a report screen to a virtual drive in CSV format.
(GT SoftGOT2000 only)
· Writing/reading data to/from a recipe file in CSV format
· Reading a CSV file from drive C or D of the GOT with a personal computer
(GT21 and GS21)
· Copying a CSV file from drive C or D to any other drive
(GT21 and GS21)
Make sure that this bit is on when you execute the following operations using the CSV file that has been converted from 
another format or created during the turn-on of the bit.
· Converting the CSV file to a binary file
· Performing an operation that uses the CSV file as a recipe file

• b3: When this bit is turned on, all buttons except the [List] and [Latest] buttons are disabled on the [Operation Log 

Set value Delay time

0 None

1 to 100 Set value × 5 (ms)

101 or more 500 (ms)
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Information] screen of the utility.
• b4: When this bit is turned on, the printing operations are disabled on the [Print file list display] screen of the file print 
function in the utility.

• b5: Use prohibited
• b6: When this bit is turned on, the GOT data package acquisition is executed when the trigger backup of the backup/
restoration function is complete.
When any backup trigger condition of any channel is satisfied, the GOT data package acquisition is executed.

• b7: Tun on this bit to close the displayed system window and switch the base screen, when switching the base screen 
with the system window open.
The system window is not closed if the base screen remains the same before and after switching.
For system windows, refer to the following.

➟5.2.1 ■2 (5) Using an overlap window as the system window
• b8 to b15: Use prohibited

(61)Document Display Common Control (GS523)
• b0: When this bit is turned on, PDF files are not cached, and the cached PDF files are not displayed and updated.
• b1: When this bit is turned on, the search history file is not created or updated.
• b2: When this bit is turned on, an A4 or smaller PDF document is displayed in high quality (144 dpi resolution).
When this bit is turned off, a PDF document is displayed in standard quality (72 dpi resolution).

• b3: When this bit is turned on while a PDF document is displayed, the document is fit to the object width.
When a document is displayed for the first time while this bit is on, the document is fit to the object width, regardless of 
the selection for [Initial Display Size].

• b4 to b15: Use prohibited

(62)Report Common Control (GS524)
GT27, GT25, GT23, and GS25 do not support b15.
GT21 and GS21 support b15 only.
• b0: This bit is activated when [Output Timing] is set to [At the time of data collection] in the [Screen Property] dialog for 
a report screen.
While this bit is on, automatic page breaks are disabled and the footer is not output to a report when the number of output 
lines reaches the set value of [Page Lines] in the [Report Setting] dialog.
If [Insert a page break before an output] is selected in the [Report Setting] dialog, a page break will be inserted according 
to the previously output contents even after automatic page breaks are disabled.
To enable automatic page breaks again, restart the GOT.

• b1: This bit is activated when [Output Timing] is set to [At the time of data collection] in the [Screen Property] dialog for 
a report screen.
When this bit is turned on while GS524.b0 is on, a page break is inserted.
If a footer is set in the previously output report screen, the footer will be printed and then a page break will be inserted.

• b2: This bit is activated when [Output Timing] is set to [When trigger condition is satisfied] in the [Screen Property] dialog 
for a report screen.
When this bit is turned on, the data stored in a temporary file is output upon satisfaction of the output trigger condition. 
If the number of collections of data stored in the file is less than or equal to the set value of [Number of repeats] in the 
[Screen Property] dialog for a report screen, the number of repeats will be assumed to be the number of collections of 
data decreased by one.

• b3 to b14: Use prohibited
• b15: This bit is activated when [Output Timing] is set to [When trigger condition is satisfied] in the [Screen Property] 
dialog for a report screen and a Brightek's serial printer is connected.
When the output trigger condition is satisfied while this bit is on, the Brightek's serial printer outputs a report with GB 
code.
If the bit is turned off after the report output, the output destination will still be the Brightek's serial printer.
To change the printer, restart the GOT.

(63)Delay Hard Copy Execution (GS526)
Set delay time to output a hidden screen image using the hard copy function.
When the start trigger condition is satisfied, the hard copy processing is executed after the set delay time is passed.
Set the delay time as below according to the values to be stored.

Set value Delay time

0 1 second

1 to 10 1 to 10 seconds
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(64)Network No. For Monitor Station Disconnected (CH1 to CH4) (GS530, GS540, GS550, GS560)
Controls the disconnection and the connection of the monitor stations by the station.
• b0 to b7: the network No. for the station to be disconnected is specified. (0 to 239)
One network No. can be specified per channel.

• b8 to b15: Use prohibited
The devices are enabled only when the following communication drivers are used.
• [Serial(MELSEC)]
• [AJ71QC24, MELDAS C6*]
• [AJ71C24/UC24]
• [Bus(A/QnA)]
• [Bus(Q)]
• [CC-Link(G4)]
Specify the station to be disconnected by using the following GOT special registers.

➟12.1.3 ■5 (65) Monitor Station Disconnection (CH1 to CH4) (GS531 to GS538, GS541 to GS548, GS551 to 
GS558, GS561 to GS568)

(65)Monitor Station Disconnection (CH1 to CH4) (GS531 to GS538, GS541 to GS548, GS551 to GS558, 
GS561 to GS568)
Each bit corresponds to a station number when one of the following communication drivers is used. Turning on a bit 
disconnects the corresponding station from the GOT.
The following shows the communication drivers supported by the GOT models.
○ : Available, - : Not available

*1 Use the following GS devices to specify network numbers.

➟12.1.3 ■5 (64) Network No. For Monitor Station Disconnected (CH1 to CH4) (GS530, GS540, GS550, GS560)
*2 When the network connected through the PLC is the CC-Link IE TSN, 0 to 120 stations can be disconnected.

11 or more 10 seconds

Set value Delay time

Communication driver

GT27,  
GT25, 
GT23, 
GS25

GT21, 
GS21 Communication driver

GT27, 
GT25, 
GT23, 
GS25

GT21, 
GS21

[Bus Q] *1*2 ○ - [azbil DMC50] ○ ○

[Bus A/QnA]*1*2 ○ - [RKC SR Mini HG(MODBUS)] ○ -

[Serial(MELSEC)] *1*2 ○ - [FUJI Temperature Controller/Digital Controller] ○ ○

[AJ71QC24, MELDAS C6*] *1*2 ○ - [YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced]

○ -

[AJ71C24/UC24] *1*2 ○ - [Shinko Technos Controller] ○ -

[CC-Link(G4)] *1*2 ○ - [CHINO Controllers(MODBUS)] ○ -

[MEI Nexgenie] ○ ○ [MODBUS/RTU Master] ○ ○

[IAI ROBO CYLINDER] ○ ○ [Ethernet(MITSUBISHI ELECTRIC), Gateway] ○ ○

[IAI X-SEL] ○ ○ Ethernet(FX), Gateway] ○ ○

[Panasonic MINAS A4] ○ - [Ethernet(FREQROL), Gateway] ○ ○

[Panasonic MINAS A5] ○ - [Ethernet(FREQROL(Batch monitor)), Gateway] ○ ○

[MELSERVO-J4,J3,J2S/M,JE] ○ ○ [Ethernet(MELSERVO), Gateway] ○ ○

[FREQROL 500/700/800,SENSORLESS SERVO] ○ ○ [Ethernet(OMRON NJ/NX), Gateway] ○ ○

[FREQROL 800] ○ ○ [Ethernet(HITACHI IES), Gateway] ○ -

[FREQROL(Batch monitor)] ○ ○ [Ethernet(HITACHI), Gateway] ○ -

[OMRON THERMAC/INPANEL NEO] ○ ○ [Ethernet(YASKAWA High Speed Ethernet Server), 
Gateway]

○ -

[OMRON Digital Temperature Controller] ○ ○ [Ethernet(LS Industrial Systems XGK), Gateway] ○ ○

[MODBUS/TCP Master, Gateway] ○ ○ [Ethernet(SLMP), Gateway] ○ ○

[azbil SDC/DMC] ○ ○
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For the multi-channel connection, the target bit of the device corresponding to each channel No. (CH1 to CH4) turns on.
1: Disconnected
0: Connected
When the GOT is connected to the AZBIL temperature controller (DMC50), the specified station number of the DMC50 
differs from the station numbers of the other models.
The following shows the station numbers for each device.

(a) Correspondence between station numbers and device bits (when connecting to a controller other 
than the AZBIL temperature controller (DMC50))
The station corresponding to each device differs according to whether the Ethernet connection is used or not.

• With the Ethernet connection: 1 to 128

• With other than the Ethernet connection: 0 to 127

(b) Correspondence between station numbers and device bits (when connecting to the AZBIL 
temperature controller (DMC50))

Device Ethernet setting No.

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
531

GS
541

GS
551

GS
561 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

GS
532

GS
542

GS
552

GS
562 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17

GS
533

GS
543

GS
553

GS
563 48 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33

GS
534

GS
544

GS
554

GS
564 64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

GS
535

GS
545

GS
555

GS
565 80 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65

GS
536

GS
546

GS
556

GS
566 96 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81

GS
537

GS
547

GS
557

GS
567 112 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97

GS
538

GS
548

GS
558

GS
568 128 127 126 125 124 123 122 121 120 119 118 117 116 115 114 113

Device Station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
531

GS
541

GS
551

GS
561 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

GS
532

GS
542

GS
552

GS
562 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

GS
533

GS
543

GS
553

GS
563 47 46 45 44 43 42 41 40 39 38 37 36 35 34 33 32

GS
534

GS
544

GS
554

GS
564 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49 48

GS
535

GS
545

GS
555

GS
565 79 78 77 76 75 74 73 72 71 70 69 68 67 66 65 64

GS
536

GS
546

GS
556

GS
566 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81 80

GS
537

GS
547

GS
557

GS
567 111 110 109 108 107 106 105 104 103 102 101 100 99 98 97 96

GS
538

GS
548

GS
558

GS
568 127 126 125 124 123 122 121 120 119 118 117 116 115 114 113 112

Device Station-Sub station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

GS
531

GS
541

GS
551

GS
561 1-15 1-14 1-13 1-12 1-11 1-10 1-9 1-8 1-7 1-6 1-5 1-4 1-3 1-2 1-1 1-0

GS
532

GS
542

GS
552

GS
562 2-15 3-14 2-13 2-12 2-11 2-10 2-9 2-8 2-7 2-6 2-5 2-4 2-3 2-2 2-1 2-0
12. APPENDICES
12.1 GOT Internal Device

12 - 85



(1) Error station 
When an error station is disconnected from the GOT, the temperature controller and servo 
amplifier faulty station information corresponding to the disconnected station turns off.

➟(66) Faulty Station Information (CH1 to CH4) (GS281 to GS288, GS301 to GS308, GS321 to GS328, 
GS341 to GS348)

(2) Restrictions
• The GOT cannot disconnect the station number 128 or later, or the station number and the sub station 

number 9-0 or later.
• The stations with the station numbers specified on GT Designer3 cannot be disconnected using the 

device of the temperature controller and servo amplifier monitor station disconnection. 
For details of specifying station numbers, refer to the following.
➟GOT2000 Series Connection Manual for a controller used

(66)Channel Shutdown Control (CH1 to CH4) (GS539, GS549, GS559, GS569)
Communication of each channel is prohibited.
When this signal turns on, the Channel Observation Notification Information (GS299, GS319, GS339, GS359) for the 
channel whose communication is prohibited turns off.

➟12.1.3 ■2 (67) Channel Observation Notification Information (GS299, GS319, GS339, GS359)
• b0: While the bit is on, communication of each channel is prohibited.
• b1 to b15: Use prohibited
The following shows the communication drivers that support the device.
○: Supported, -: Not supported

GS
533

GS
543

GS
553

GS
563 3-15 3-14 3-13 3-12 3-11 3-10 3-9 3-8 3-7 3-6 3-5 3-4 3-3 3-2 3-1 3-0

GS
534

GS
544

GS
554

GS
564 4-15 4-14 4-13 4-12 4-11 4-10 4-9 4-8 4-7 4-6 4-5 4-4 4-3 4-2 4-1 4-0

GS
535

GS
545

GS
555

GS
565 5-15 5-14 5-13 5-12 5-11 5-10 5-9 5-8 5-7 5-6 5-5 5-4 5-3 5-2 5-1 5-0

GS
536

GS
546

GS
556

GS
566 6-15 6-14 6-13 6-12 6-11 6-10 6-9 6-8 6-7 6-6 6-5 6-4 6-3 6-2 6-1 6-0

GS
537

GS
547

GS
557

GS
567 7-15 7-14 7-13 7-12 7-11 7-10 7-9 7-8 7-7 7-6 7-5 7-4 7-3 7-2 7-1 7-0

GS
538

GS
548

GS
558

GS
568 8-15 8-14 8-13 8-12 8-11 8-10 8-9 8-8 8-7 8-6 8-5 8-4 8-3 8-2 8-1 8-0

Device Station-Sub station

CH
1

CH
2

CH
3

CH
4 b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

Communication driver Supported/
Unsupported Communication driver Supported/

Unsupported

[Bus Q] ○ [Panasonic MINAS A4] ○

[Bus A/QnA] ○ [Panasonic MINAS A5] ○

[Serial(MELSEC)] ○ [Muratec MPC] ○

[AJ71QC24, MELDAS C6*] ○ [Computer] -

[AJ71C24/UC24] ○ [MELSERVO-J4,J3,J2S/M,JE] ○

[CC-Link(G4)] ○ [FREQROL 500/700/800,SENSORLESS SERVO] ○

[MELSECNET/H] - [FREQROL 800] ○

[CC-Link Ver.2(ID)] - [FREQROL(Batch monitor)] ○

[CC-Link IE Controller Network] - [OMRON THERMAC/INPANEL NEO] ○

[CC-Link IE Field Network] - [OMRON Digital Temperature Controller] ○

[CC-Link IE TSN] - [azbil SDC/DMC] ○

[MELSEC-FX] ○ [azbil DMC50] ○

[MELSEC-WS] ○ [RKC SR Mini HG(MODBUS)] ○

[MEI Nexgenie] ○ [FUJI Temperature Controller/Digital Controller] ○
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(67)MODBUS Communication Control Function (GS570 to GS576, GS590 to GS596, GS597 to GS603, 
GS604 to GS610, GS611 to GS617)
When some controllers do not comply with the specifications, this function enables the GOT to reduce the communication 
delay in the MODBUSnetwork.
When the MODBUS/RTU master connection or the MODBUS/TCP master connection is used, each device enables a 
function code, or operates as shown below.
The MODBUS Communication Control Function contains two types: the MODBUS Communication Control Function 
(Common) and the MODBUS Communication Control Function (CH1 to CH4). For the MODBUS Communication Control 
Function (Common), the device values are applied to all relevant channels. For the MODBUS Communication Control 
Function (CH1 to CH4), the device values are applied to each applicable channel.
Use GS579 to determine which type of the MODBUS Communication Control Function is applied.

➟(68) Channel Setting of MODBUS Communication Control Function (GS579)
When applicable devices store a value as shown below, the GOT operates with the values specified in the communication 
setting of the utility.
• For the MODBUS Communication Control Function (Common), GS571 to GS576 each store 0.

[Multidrop(Slave)] - [YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced] ○

[OMRON SYSMAC] ○ [Shinko Technos Controller] ○

[YASKAWA GL] ○ [CHINO MODBUS device] ○

[YASKAWA CP9200 (H)] ○ [MODBUS/RTU Master] ○

[YASKAWA CP9300MS (MC compatible)] ○ [MODBUS/RTU Slave] -

[YASKAWA MP2000/MP900/CP9200SH] ○ [Ethernet(MITSUBISHI ELECTRIC), Gateway] ○

[AB SLC500, AB 1:N] ○ [Ethernet(FX), Gateway] ○

[AB MicroLogix] ○ [Ethernet(FREQROL), Gateway] ○

[AB MicroLogix(Extended)] ○ [Ethernet(FREQROL(Batch monitor)), Gateway] ○

[AB Control/CompactLogix] ○ [Ethernet(YASKAWA), Gateway] ○

[SHARP JW] ○ [Ethernet(YASKAWA MP3000), Gateway] ○

[TOSHIBA PROSEC T/V] ○ [Ethernet(YASKAWA High Speed Ethernet Server), 
Gateway] ○

[HITACHI IES HIDIC H] ○ [Ethernet(YOKOGAWA), Gateway] ○

[HITACHI IES HIDIC H(Protocol2)] ○ [Ethernet(AB), Gateway] ○

[Ethernet(HITACHI IES), Gateway] ○ [Ethernet(AB MicroLogix), Gateway] ○

[Panasonic MEWNET-FP] ○ [Ethernet(AB Tag), Gateway] ○

[Panasonic MEWTOCOL-7] ○ [Ethernet(OMRON), Gateway] ○

[SIEMENS S7-200] ○ [Ethernet(OMRON NJ/NX), Gateway] ○

[SIEMENS S7-300/400] ○ [Ethernet(TOSHIBA nv), Gateway] ○

[YOKOGAWA FA500/FA-M3/STARDOM] ○ [Ethernet(HITACHI), Gateway] ○

[Serial(KEYENCE)] ○ [Ethernet(LS Industrial Systems XGK), Gateway] ○

[JTEKT TOYOPUC-PC] ○ [Ethernet(SIEMENS S7), Gateway] ○

[HITACHI S10mini/S10V] ○ [Ethernet(SIEMENS OP), Gateway] ○

[FUJI MICREX-F] ○ [Ethernet(FUJI), Gateway] ○

[FUJI MICREX-SX SPH] ○ [Ethernet(KEYENCE), Gateway] ○

[GE (SNP-X)] ○ [MODBUS/TCP Master, Gateway] ○

[SHIBAURA MACHINE TCmini] ○ [MODBUS/TCP Slave, Gateway] -

[KOYO KOSTAC/DL] ○ [PROFIBUS DP] ○

[LS Industrial Systems MASTER-K] ○ [DeviceNet] ○

[Hirata HNC] ○ [Ethernet(MICROCOMPUTER) ] -

[IAI ROBO CYLINDER] ○ [Ethernet(SLMP), Gateway] ○

[IAI X-SEL] ○ [Ethernet(CC-Link IE Field Network Basic)] -

[SICK Flexi Soft] ○ [Ethernet(MELSERVO), Gateway] ○

Communication driver Supported/
Unsupported Communication driver Supported/

Unsupported
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• For the MODBUS Communication Control Function (CH1), GS591 to GS596 each store 0.
• For the MODBUS Communication Control Function (CH2), GS598 to GS603 each store 0.
• For the MODBUS Communication Control Function (CH3), GS605 to GS610 each store 0.
• For the MODBUS Communication Control Function (CH4), GS612 to GS617 each store 0.

(1) Function codes supported by the GOT
For function codes supported by the GOT, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) 
For GT Works3 Version1

(2) Setting MODBUS Communication Control Function
Set the MODBUS Communication Control Function at the GOT startup with the project script or others.
Do not change the setting after the communication starts.
The communication error may occur.

Device
Function

Common CH1 CH2 CH3 CH4

GS570.b0 GS590.b0 GS597.b0 GS604.b0 GS611.b0 When the bit turns on, the function code 0Fh (write multiple coils) is not 
available.

GS570.b1 GS590.b1 GS597.b1 GS604.b1 GS611.b1 When the bit turns on, the function code 10h (write multiple registers) is not 
available.

GS570.b2 
to b15

GS590.b2 
to b15

GS597.b2 
to b15

GS604.b2 
to b15

GS611.b2 
to b15 Use prohibited

GS571 GS591 GS598 GS605 GS612

Set the maximum number of devices (1 to 2000) for a message with function 
code 01h (read coils).
When 0 is set, the maximum number of devices is set as shown below.
• MODBUS/TCP: 1000
• MODBUS/RTU: 2000
When a value other than the above is set, the maximum number of devices is 
2000.

GS572 GS592 GS599 GS606 GS613

Set the maximum number of devices (1 to 2000) for a message with function 
code 02h (read input relays).
When 0 is set, the maximum number of devices is set as shown below.
• MODBUS/TCP: 1000
• MODBUS/RTU: 2000
When a value other than the above is set, the maximum number of devices is 
2000.

GS573 GS593 GS600 GS607 GS614

Set the maximum number of devices (1 to 125) for a message with function 
code 03h (read holding registers).
When a value other than 1 to 125 is set, the maximum number of devices is 
125.

GS574 GS594 GS601 GS608 GS615

Set the maximum number of devices (1 to 125) for a message with the function 
code 04h (read input registers).
When a value other than 1 to 125 is set, the maximum number of devices is 
125.

GS575 GS595 GS602 GS609 GS616

Set the maximum number of devices for a message with the function code 0Fh 
(write multiple coils).
The following shows the setting range of the maximum number of device 
points.
• MODBUS/TCP: 1 to 800
• MODBUS/RTU: 1 to 1968
When 0 is set, the maximum number of devices is 800.
When a value other than the above is set, the maximum value in the setting 
range is applied.

GS576 GS596 GS603 GS610 GS617

Set the maximum number of devices for a message with the function code 10h 
(write multiple registers).
The following shows the setting range of the maximum number of devices.
• MODBUS/TCP: 1 to 100
• MODBUS/RTU: 1 to 123
When 0 is set, the maximum number of devices is 100.
When a value other than the above is set, the maximum value in the setting 
range is applied.
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(68)Channel Setting of MODBUS Communication Control Function (GS579)
The MODBUS Communication Control Function setting can be selected for each channel.
GT21 and GS21 support b0 and b1.

➟(67) MODBUS Communication Control Function (GS570 to GS576, GS590 to GS596, GS597 to GS603, 
GS604 to GS610, GS611 to GS617)

• b0: The MODBUS Communication Control Function for CH1 can be selected.
Turning on this bit applies the MODBUS Communication Control Function (CH1) (GS590 to GS596).
Turning off this bit applies the MODBUS Communication Control Function (Common) (GS570 to GS576).

• b1: The MODBUS Communication Control Function for CH2 can be selected.
Turning on this bit applies the MODBUS Communication Control Function (CH2) (GS597 to GS603).
Turning off this bit applies the MODBUS Communication Control Function (Common) (GS570 to GS576).

• b2: The MODBUS Communication Control Function for CH3 can be selected.
Turning on this bit applies the MODBUS Communication Control Function (CH3) (GS604 to GS610).
Turning off this bit applies the MODBUS Communication Control Function (Common) (GS570 to GS576).

• b3: The MODBUS Communication Control Function for CH4 can be selected.
Turning on this bit applies the MODBUS Communication Control Function (CH4) (GS611 to GS617).
Turning off this bit applies the MODBUS Communication Control Function (Common) (GS570 to GS576).

• b4 to b15: Use prohibited

(69)Microcomputer Connection Extended Setting (CH1 to CH4) (GS580 to GS583)
GT21 and GS21 support GS580.b0 and GS581.b0.
• b0: For the microcomputer connection (serial), when the bit turns on, if the data format of the message format is Format 
12 or 13, communication packets are fully compatible with those of the SCHNEIDER EJH's memory link method.
(ON: Fully compatible, OFF: Partly compatible)
For the details on the message format of the microcomputer connection (serial), refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

• b1 to b7: Use prohibited
• b8: For the microcomputer connection (Ethernet), when the bit turns on, if the data format of the message format is 
Format 3 or 4, communication packets are fully compatible with those of the GOT-F900 series microcomputer 
connection.
(ON: Fully compatible, OFF: Partly compatible)
For the details on the message format of the microcomputer connection (Ethernet), refer to the following.

➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 
Works3 Version1

• b9 to b15: Use prohibited

(70)CC-Link IE TSN Control (GS620)
• b0: When the bit is turned on, the firmware update of the CC-Link IE TSN communication unit is prohibited.
• b1 to b15: Use prohibited

Setting example of project script
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(71)Operator Management Common Control (GS621)
Controls the operator information management.
GT21 and GS21 support b0 and b2.
• b0: Turning on this bit inactivates the delete button on the operator management screen. This disables deletion of the 
existing operator information.
If the GOT has operator information that does not exist in the operator management file to be imported, the GOT retains 
its operator information.
When the operator name or operator ID to be imported is the same as that of the import destination, the operator 
information is not imported.

• b1: Turning on this bit inactivates the edit button on the operator management screen. This disables editing of the 
operator information when an inactivated operator is selected.
If both b0 and b1 are on, the inactivated operator information is not updated when an operator management information 
file is imported.

• b2: Turning on this bit inactivates the import button on the operator management screen.
• b3 to b15: Use prohibited

(72)System Screen Operation Restriction (GS622)
Restricts operation on the screens in the [Data] tab of the utility.
This device setting is applied when any of the relevant screens is displayed.
Turning on or off the signal while a relevant screen is displayed does not switch between restrictions.
• b0: Turning on this bit restricts access to the specified drives on the [Alarm info.], [Image file], [Recipe Information], 
[Logging info.], [Operation Log Information], and [SD card format] screens of the utility.
Use GS623 or GS624 to specify the drives to which access is restricted.

• b1: Turning on this bit restricts the display of the [Package management] and [GOT data package acquisition] screens.
When these screens are selected on the [Data] tab, an error dialog appears.

• b2: Turning on this bit restricts the display of the [SRAM management] screen.
When this screen is selected on the [Data] tab, an error dialog appears.

• b3 to b15: Use prohibited
For details on the utility screens, refer to the following manual.

➟GOT2000 Series User's Manual (Utility)
For the available drives by GOT model, refer to the following.

➟1.2.7 Specifications of available devices

(73)Specify Drive to Prohibit Write Operation (System Screen) (GS623)
Prohibits writing to the specified drives when GS622.b0 is on.
On an access-restricted screen, if you display the contents of a drive to which writing is prohibited, the buttons relevant 
to writing become inactive.
If you perform conversion, copying, or moving of data to the drive to which writing is prohibited, the attempt fails and an 
error dialog appears.
This device setting is applied when any of the relevant screens is displayed.
Turning on or off the signal while a relevant screen is displayed does not switch between restrictions.
• b0: Turning on this bit prohibits writing to all drives.
• b1: Turning on this bit prohibits writing to drive A.
• b2: Turning on this bit prohibits writing to drive B.
• b3: Turning on this bit prohibits writing to drive E.
• b4: Turning on this bit prohibits writing to drive F.
• b5: Turning on this bit prohibits writing to drive G.
• b6: Turning on this bit prohibits writing to drive N.
• b7 to b15: Use prohibited

(74)Specify Drive to Hide (System Screen) (GS624)
Restricts access to specified drives when GS622.b0 is on.
If you perform conversion, copying, or moving of data to the drive to which access is restricted, the attempt fails and an 
error dialog appears.
This device setting is applied when any of the relevant screens is displayed.
Turning on or off the signal while a relevant screen is displayed does not switch between restrictions.
• b0: Turning on this bit restricts access to all drives.
Since no operation is available on a relevant screen, the screen itself is not displayed.

• b1: Turning on this bit restricts access to drive A.
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When drive A is selected, the files are not displayed and the [Move], [Rename], [New folder], and [Del] buttons are 
inactivated.
Drive A is not displayed on the SD card format screen.

• b2: Turning on this bit restricts access to drive B.
• b3: Turning on this bit restricts access to drive E.
• b4: Turning on this bit restricts access to drive F.
• b5: Turning on this bit restricts access to drive G.
• b6: Turning on this bit restricts access to drive N.
• b7 to b15: Use prohibited

(75)Touch Position Color Acquisition Ready signal (GS630)
• b0: Turning on the bit makes the GOT ready for acquiring the color information at the touched position on the GOT 
screen. In this status, even when an object or others is touched, the object or others does not function.
Turning off the bit without acquiring the color information cancels the status.

• b1 to b15: Use prohibited

(76)Date Format Control (GS632)
Controls the date format used for the operation log information of the utility by turning b0 and b1 on or off.
This is available for the [Operation Log Data List] screen.
This is also available for the dialogs displayed from the [Operation Log Data List] screen.
The specified data format is applied to the [Operation Log Data List] screen when the screen is displayed.

(77)Specify Notification While Monitoring Stopped (GS633)
This device is available only when an overlap window is output to the display using the video output function.
Specify the screen on the display when the GOT screen transitions to a utility screen or extended system application 
screen while the video output function is used.
• 0: Displays the monitoring stopped message in the center of the screen.
This message does not appear if the size of the overlap window to be output to the display is less than 190 dots × 56 
dots.

• 1. Displays the screen specified using GS634.
The monitoring stopped message appears in the center of the screen when: 0 is specified for the screen number, the 
screen having the specified number does not exist, or the screen security level is insufficient.

• 2: Retains the screen on the display without notifying monitoring stopped.
When 3 or greater value is input, the value is handled as 0.

(78)Specify Screen No. to be Displayed While Monitoring Stopped (GS634)
Specify the screen number of the window to be displayed when GS633 is 1.
Only figures can be displayed on the window screen while monitoring is stopped.

(79)Base Screen Size Expansion Common Control (GS635)
• b0: Turning on this bit displays the specified area of the expanded base screen, when the screen is switched to an 
expanded base screen.
To specify the upper-left coordinates of the area to be in view, use GS636 and GS637.

• b1: Turning on this bit disables swiping to scroll the screen.
• b2 to b15: Use prohibited

(80)Specify Expanded Base Screen Position (GS636 and GS637)
Specify the upper-left coordinates of the area to be in view, when the screen is switched to an expanded base screen.

• GS636: X coordinate
• GS637: Y coordinate

If the specified area extends off the base screen, the area is adjusted to fit within the base screen.
Example) Displaying an expanded base screen (1600 × 960) on GT27-V (640 × 480)

GS632.b0 GS632.b1 Date format

OFF OFF Not controlled (Date format of the system language)

ON OFF Year, month, date

OFF ON Month, date, year

ON ON Date, month, year
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(81)GOT Reset Control (GS639)
GT21 and GS21 support b15 only.
• b0 to b13: Use prohibited
• b14: When the bit is turned on, all the GOT functions exit. (The GOT power can be turned off safely.)
• b15: When the bit is turned on, the software reset for the GOT is performed at the rising edge timing.

■6 Read device (GS1792 to GS2047)

(1) VNC Server Function Control (GS1792)
This is disabled when the GOT network interaction function is used.
• b0: When the bit is turned on, the device disables communication from the VNC client.
• b1: When the bit is turned on, the device disables operations from the VNC client.
• b2 to b7: Use prohibited
• b8: When the bit is turned on, the authorization guarantee time for the VNC server function is disabled.
• b9 to b15: Use prohibited

(2) Gesture Common Control (GS1794)
• b0: When the bit turns on, the object gesture function becomes disabled.
The single touch operation of the object remains enabled.

• b1: When the bit turns on, the single touch operation of the object becomes disabled.
The object gesture function remains enabled.

• b2 to b15: Use prohibited

(3) Authorization Status Control (GS1795)
Controls the authorization of the GOT network interaction function.
This device is activated in an applicable GOT in the control group.
• b0: When this bit turns on, the automatic acquisition of the authorization becomes disabled.
On unauthorized equipment, even if you switch a screen to another screen in which the authorization control is enabled, 
the equipment cannot automatically obtain the authorization.

• b1 to b15: Use prohibited

(4) Authorization Management Control (GS1796)
Controls the authorization of the GOT network interaction function.
This device is activated in the master GOT in the control group.

When the specified area extends off 
the base screen in the X-axis direction After the position adjustment

After the position adjustment

Base screen (1600 × 960) Base screen (1600 × 960)

Base screen (1600 × 960)Base screen (1600 × 960)

Specified area (1280, 0)

View on the GOT

View on the GOT

Adjusted area

When the specified area extends off 
the base screen in both the X- and Y-axis directions

Specified area (1280, 720)

Adjusted area

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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• b0: When this bit turns on, equipment except the master GOT in the control group becomes prohibited from obtaining 
the authorization.
The authorized equipment (other than the master GOT) loses the authorization.
When the bit is used in combination with b1, the authorization can be released during the authorization guarantee time.

• b1: When this bit turns on, the authorization guarantee time becomes invalid.
• b2: When this bit turns on, all pieces of equipment including the master GOT in the control group become prohibited 
from obtaining the authorization.
The authorized equipment loses the authorization.
When the bit is used in combination with b1, the authorization can be released during the authorization guarantee time.

• b3 to b15: Use prohibited

(5) Log Viewer Common Control (GS1797)
Specify the behavior of the log viewer.
• b0: When this bit is turned on, the access authentication and the remote password authentication set for the connected 
controller are performed automatically if the controller IP address is identical to the one connected in the last session.
The automatic authentication is performed with the user name and password used in the last session.
At the first startup of the log viewer, the automatic authentication is not performed because no user name and password 
are recorded.
When you start the log viewer with the special function switch (log viewer), the switch setting overrides the setting of this 
bit.

• b1 to b15: Use prohibited

(6) VNC Server GOT Processing Balance Control (GS1798)
Set the load balance between processing of the VNC server function and processing of the other functions in the GOT, 
whether or not the GOT is connected with the VNC client.

• b0: Turning on this bit prioritizes processing of the functions in the GOT.
The number of the other processing delays caused by the VNC server function decreases.

• b1: Turning on this bit applies standard balance between processing of the VNC server function and processing of 
the other functions in the GOT.

• b2: Turning on this bit prioritizes processing of the VNC server function.
The speed of remote screen refresh is higher than that when b0 or b1 is on.

• b3: Turning on this bit prioritizes processing of the VNC server function.
The priority on the processing of the VNC function and the speed of remote screen refresh are higher than those 

when b2 is on.
• b4: Turning on this bit prioritizes processing of the VNC server function.

The priority on the processing of the VNC function and the speed of remote screen refresh are higher than those 
when b3 is on.

• b5 to b15: Use prohibited
When multiple bits are turned on, the bit having the smallest number is prioritized.
When all the bits are off, the GOT operates according to the setting of [GOT processing balance when VNC server is in 
operation].

➟10.5.4 [VNC Server] dialog

(7) Recipe Control (GS1800)
• b0 to b1: Use prohibited
• b2: When this bit is turned on, the recipe special control is executed.
• b3 to b13: Use prohibited
• b14: When this bit is turned on, the Operation Completed signal (GS1010.b14) and the Operation Error signal 

(GS1010.b15) turn off.
➟12.1.3 ■3 (32) Recipe Status(GS1010)

• b15: Use prohibited

(8) Recipe Special Control Action (GS1801)
Specify the control action. The action varies with the stored value.
0: Resets the Recipe Special Control Result device (GS1011) and the Recipe Special Control No. device (GS1012) to 0.
1: Reads a record from the target recipe data into GOT data registers (GD).
2: Overwrites the values of a record in the target recipe data with the values of GOT data registers (GD).
4: Outputs recipe information to GOT data registers (GD).
5: Searches the target recipe data based on the values of GOT data registers (GD).
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(9) Recipe Special Control Target Type (GS1802)
Specify the target of the recipe special control.
• b0: When this signal is turned on, record information (record No., record attribute, and record name) is set as the control 
target.

• b1: When this signal is turned on, the update date and time of a record is set as the control target.
• b2: When this signal is turned on, the device values of a record are set as the control target.
• b3: When this signal is turned on, device comments are set as the control target.
• b4 to b15: Use prohibited

(10)Recipe Special Control Start GD Device No. (GS1803)
Specify the start device number of the GOT internal devices (GD) to be used.

(11)Recipe Special Control Recipe No. (GS1805)
Specify the recipe number of a target recipe setting.

(12)Recipe Special Control Record No. (GS1806)
Specify the record number of a target record.

(13)Recipe Special Control Row No. (GS1807)
Specify the start row of a record as necessary.
Subtract 1 from a target row number, and then set the result as the value of GS1807.
Example 1) To specify row No. 1, set GS1807 to 0.
Example 2) To specify row No. 65536, set GS1807 to 65535.

(14)Recipe Special Control Points (GS1808)
Specify the number of target rows of a record as necessary.
Starting from the row specified with GS1807, the specified number of rows are targeted for the recipe special control.

(15)Recipe Display (Record List) Control (GS1809)
• b0: Turning on this bit hides the confirmation or nonfiction dialog that appears during a record manipulation after this 

bit is turned on.
So, you can skip the confirmation step.
The manipulation result is notified by GS1015 and GS1016.

➟12.1.3 ■3 (37) Recipe Display (Record List) Target Record No. (GS1015)
12.1.3 ■3 (38) Recipe Display (Record List) Record Manipulation Result (GS1016)

• b1 to b14: Use prohibited
• b15: When this bit is turned on, GS1016 turns off.

This bit is invalid when the recipe display (record list) is not displayed.
When the recipe display (record list) is displayed while this bit is on, GS1016 turns off.

(16)Special Function Switch Special Control (GS1810)
• b0: Turning on this bit enables the iQSS utility special control function.

While this signal is on, press the special function switch for which [iQSS Utility] is selected for [Switch Action] to 
execute the iQSS utility special control.

• b1 to b15: Use prohibited
For details on the iQSS utility special control function, refer to the following.

➟GOT2000 Series User's Manual (Monitor)
For the special function switch settings, refer to the following.

➟8.2.9 ■1 (2) (v) Setting for [iQSS Utility]

(17)iQSS Utility Special Control Start GD Device No. Specification (GS1811)
Specify the start device of the GD devices used for the iQSS utility special control.
Setting range: 0 to 65529.
Data type: Unsigned binary
Parameters are stored in seven GD devices from the start device specified using this device.
The following shows the structure of the parameters to be stored.
Example) When GD1000 is set as the start device

Storage device (GD) Parameter

GD1000 Sensor device No.: 0 to 65534
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(18)iQSS Utility Special Control Number of Parameters (GS1812)
Specify the number of sensor devices used for the iQSS utility special control.
Data type: Unsigned binary
Example) When setting 500 to GS1811 and 2 to GS1812

• GD500 to GD506: Parameters to start the first sensor device are stored.
• GD507 to GD513: Parameters to start the second sensor device are stored.

(19)SD Card Access Switch Status Control (GS1820)
• b0: When the bit is turned on, the control for GS1820.b1 is enabled.
When the bit is turned off, the control for GS1820.b1 is disabled.

• b1: When the bit is turned on, the access to the SD card is allowed.
• b2 to b15: Use prohibited

(20)USB Drive Common Control (GS1824)
• b0: When the bit is turned on, the USB memory connected to drive E on the GOT can be removed.
• b1: When the bit is turned on, the USB memory connected to drive F on the GOT can be removed.
• b2: When the bit is turned on, the USB memory connected to drive B on the GOT can be removed.
• b3: When the bit is turned on, the USB memory connected to drive G on the GOT can be removed.
• b4: When the bit is turned on, the USB memory connected to drive E on the GOT can be removed.
• b5: When the bit is turned on, the USB memory connected to drive F on the GOT can be removed.
• b6: When the bit is turned on, the USB memory connected to drive B on the GOT can be removed.
• b7: When the bit is turned on, the USB memory connected to drive G on the GOT can be removed.
• b8 to b15: Use prohibited
For the available drives by GOT model, refer to the following.

➟1.2.8 Drive configuration of the target GOT for data transfer

GD1001

When connected to an RCPU, QCPU, or LCPU
Start XY address: 0x0000 to 0x0FE0

When connected to an FX5CPU
Intelligent Module No.: 0x01 to 0x10

GD1002

For the bit slave module
Device address: 0 to 254
The device stores 0 when any value from 255 to 65535 is set.
For the word slave module
Device address: 0 to 510
The device stores 0 when any value from 511 to 65535 is set.

GD1003

Device I/O type
• 0: Bit input
• 64: Bit output
• 128: Bit input/output
• 256: Word input
• 320: Word output
• 384: Word input/output

GD1004

Screen to be displayed
• 00: Monitor screen
• 01: Parameter information screen
b0 and b1 are used as parameters.

GD1005
Error code of the ASLINK slave module: 100 to 65535
For details on the error codes, refer to the following manual.

➟MELSEC iQ-R AnyWireASLINK Master Module User's Manual

GD1006

Error codes used for the iQSS utility special control function
• 0: Normal startup
• 1: Target network module not found
• 2: Target CPU not found
• 3: Information read error
• 4: Target sensor device not found
• 5: Profile not found
• 6: Address/station number duplicated
• 7: Incorrect profile

Storage device (GD) Parameter
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(21)Wireless Access Control (GS1840)
Controls the operations through a wireless LAN.
• b0: When this bit is turned on, writing the package data (containing system applications) is disabled through a wireless 
LAN.

• b1: When this bit is turned on, writing the package data (containing project data) is disabled through a wireless LAN.
• b2 to b7: Use prohibited
• b8: When this bit is turned on, reading data is disabled through a wireless LAN.
• b9 to b15: Use prohibited

(22)Label Name Resolution Control (GS1880)
• b0: Use prohibited
• b1: When this bit is turned on, the label name resolution is performed.
• b2: While this bit is on, executing the label name resolution resolves the label names that have been unresolved in the 
past resolution during the PLC initial processing.
This operation does not resolve the unresolved label names resulting from the nonexistence of the relevant labels on 
the PLC side, and system alarm 328 occurs. Accordingly, you can find out which cause is responsible for the unresolved 
label names.

➟6.1.4 ■6 (2) Precautions for the label name resolution
• b3 to b15: Use prohibited
For how to use the bits, refer to the following.

➟6.1.4 ■5 (3) Label name resolution performed by a user

(23)Prioritize Touch Switch Operation Control (GS1885)
Prioritizes touch switch operations or the processing being executed.
This device is available only when a communication driver of [SHARP JW] is used.
• b0: When this bit turns on, operations of the touch switches to monitor CH1 are prioritized.
• b1: When this bit turns on, operations of the touch switches to monitor CH2 are prioritized.
• b2: When this bit turns on, operations of the touch switches to monitor CH3 are prioritized.
• b3: When this bit turns on, operations of the touch switches to monitor CH4 are prioritized.
• b4 to b15: Use prohibited

(24)GOT Mobile File Operation Security Level (GS1892)
Specify a security level with which file manipulations are allowed in the GOT Mobile function, ranging from 0 to 15.
If an invalid value is specified, 0 is assumed.
If 0 is specified, file manipulations are allowed without operator authentication and level authentication.

(25)GOT Mobile Common Control (GS1896)
Specify the behavior of the GOT Mobile function.
• b0: When this bit is turned on, the URL parameter (initscreen) is enabled.

➟■7 Usage
• b1: When this bit is turned on, file manipulations with the file manager are enabled.
• b2 to b15: Use prohibited

(26)Time to Force Mobile Momentary Switch OFF (GS1899)
Set the time from when communication is lost between the GOT and a client until when the GOT forcibly turns off the 
touch switch being touched on the client.
If a touch switch is released on a client after the client loses communication with the GOT, the GOT does not recognize 
the release.
After a specified time (default: 3 seconds) elapses, the GOT forcibly turns off the touch switch.
The following shows the setting range.

Device value Time to force the touch switch off

0 to 2, 31 or more 3000 ms (3 seconds)

3 to 30
300 ms to 3000 ms
(Settable in units of 100 ms)
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(27)GOT Ethernet Setting Change (GS1900 to GS1908)
Change the GOT Ethernet setting without using the utility.

Precautions for changing the Ethernet setting
Make sure to restart the GOT after you change the Ethernet setting by using the GOT Ethernet Setting Change 
devices (GS1900 to GS1908).
Even though the new Ethernet setting is displayed in the utility, the GOT does not operates with the new setting 
until you restart the GOT.

The following shows the procedure for changing the Ethernet setting.
Step 1 Specify the category of an Ethernet setting item by using the GOT Ethernet Setting Change Category device 

(GS1900).

➟(28) GOT Ethernet Setting Change Category (GS1900)
Step 2 Store a new value to the New GOT Ethernet Setting device (GS1903 to GS1908) that corresponds to the 

Ethernet setting item to be changed.

➟(31) New GOT Ethernet Setting (GS1903 to GS1908)
Step 3 Turn on the relevant bit of the GOT Ethernet Setting Change Item device (GS1902) that corresponds to the 

New GOT Ethernet Setting device storing the new value.

➟(30) GOT Ethernet Setting Change Item (GS1902)
Step 4 Turn on the Execute GOT Ethernet Setting Change signal (GS1901.b0) to execute the Ethernet setting 

change.

➟(29) Execute GOT Ethernet Setting Change (GS1901)
Step 5 After the setting change has completed, the GOT Ethernet Setting Change Completed signal (GS1500.b1) 

and the GOT Ethernet Setting Changed signal (GS1500.b2) turn on.

➟12.1.3 ■3 (90) GOT Ethernet Setting Change Status (GS1500)
Restart the GOT.

Example) When the GOT IP address for the Ethernet standard port of GT27 is changed to 200.50.1.254 (decimal)
Step 1 Store 1 to GS1900.
Step 2 Store new values to GS1903 and GS1904 as shown below.

Step 3 Turn on GS1902.b0.
Step 4 Turn on GS1901.b0 to execute the Ethernet setting change.
Step 5 After the setting change has completed, GS1500.b1 and GS1500.b2 turn on.

Restart the GOT.

For the details of the devices (GS1900 to GS1908) used for changing the GOT Ethernet setting, refer to the following.
➟(28) GOT Ethernet Setting Change Category (GS1900)

(29) Execute GOT Ethernet Setting Change (GS1901)
(30) GOT Ethernet Setting Change Item (GS1902)
(31) New GOT Ethernet Setting (GS1903 to GS1908)

GOT IP address: C8. 32. 01. FE (hexadecimal)

GS1903

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1904

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
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(28)GOT Ethernet Setting Change Category (GS1900)
Specify the category of an Ethernet setting item to be changed.
The following shows the correspondence between the setting values and the categorized Ethernet setting items.

GOT Setting value Categorized Ethernet setting items

GT27
GT25-S
GT25-V
(excluding 
GT2505-V)

1
• GOT IP address for the Ethernet standard port
• Subnet mask for the Ethernet standard port
• Default gateway

2

• Channel number
• Host station
• GOT network number
• GOT station number

3
• GOT IP address for the wireless LAN interface
• Subnet mask for the wireless LAN interface

4
• GOT IP address for the Ethernet extended port
• Subnet mask for the Ethernet extended port
• Setting to disable the Ethernet extended port

5
• Channel number
• Setting number in the connected Ethernet controller setting
• Network number for a controller

6
• Channel number
• Setting number in the connected Ethernet controller setting
• Station number of a controller

7
• Channel number
• Setting number in the connected Ethernet controller setting
• IP address of a controller

GT25-W
GS25

1
• GOT IP address for Ethernet standard port 1
• Subnet mask for Ethernet standard port 1
• Default gateway

2

• Channel number
• Host station
• GOT network number
• GOT station number

3
• GOT IP address for the wireless LAN interface
• Subnet mask for the wireless LAN interface

4
• GOT IP address for Ethernet standard port 2
• Subnet mask for Ethernet standard port 2
• Default gateway

5
• Channel number
• Setting number in the connected Ethernet controller setting
• Network number for a controller

6
• Channel number
• Setting number in the connected Ethernet controller setting
• Station number of a controller

7
• Channel number
• Setting number in the connected Ethernet controller setting
• IP address of a controller
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(29)Execute GOT Ethernet Setting Change (GS1901)
• b0: Turning on the bit executes the Ethernet setting change. The item to be changed is specified by using the GOT 
Ethernet Setting Change Category device (GS1900) and the GOT Ethernet Setting Change Item device (GS1902).

• b1 to b15: Use prohibited

(30)GOT Ethernet Setting Change Item (GS1902)
Set an Ethernet setting item to be changed. The category of the item is specified by using the GOT Ethernet 
Setting Change Category device (GS1900).

• b0 to b4: Turning on the bit sets the corresponding Ethernet setting item to be changed.
The following shows the correspondence between the bits and the Ethernet setting items.
When GS1900 stores 1, 2, 3 or 4

GT2505-V
GT25HSV
GT23
GT21
GS21

1
• GOT IP address for the Ethernet standard port
• Subnet mask for the Ethernet standard port
• Default gateway

2

• Channel number
• Host station
• GOT network number
• GOT station number

3
Invalid

4

5
• Channel number
• Setting number in the connected Ethernet controller setting
• Network number for a controller

6
• Channel number
• Setting number in the connected Ethernet controller setting
• Station number of a controller

7
• Channel number
• Setting number in the connected Ethernet controller setting
• IP address of a controller

GOT Setting value Categorized Ethernet setting items

GOT GS1902
Ethernet setting item to be changed

When GS1900 stores 1 When GS1900 stores 2 When GS1900 stores 3 When GS1900 stores 4

GT27
GT25-S
GT25-V 
(excluding 
GT2505-V)

b0 GOT IP address for the 
Ethernet standard port Channel number GOT IP address for the 

wireless LAN interface
GOT IP address for the 
Ethernet extended port

b1 Use prohibited Host station Use prohibited Use prohibited

b2 Subnet mask for the 
Ethernet standard port GOT network number Subnet mask for the 

wireless LAN interface
Subnet mask for the 
Ethernet extended port

b3 Use prohibited GOT station number
Use prohibited

Use prohibited

b4 Default gateway Use prohibited Setting to disable the 
Ethernet extended port

GT25-W
GS25

b0 GOT IP address for 
Ethernet standard port 1 Channel number GOT IP address for the 

wireless LAN interface
GOT IP address for 
Ethernet standard port 2

b1 Use prohibited Host station Use prohibited Use prohibited

b2 Subnet mask for 
Ethernet standard port 1 GOT network number Subnet mask for the 

wireless LAN interface
Subnet mask for 
Ethernet standard port 2

b3 Use prohibited GOT station number
Use prohibited

Use prohibited

b4 Default gateway Use prohibited Setting to disable 
Ethernet standard port 2

GT2505-V
GT25HS-V
GT23
GT21
GS21

b0 GOT IP address for the 
Ethernet standard port Channel number

Use prohibited Use prohibited

b1 Use prohibited Host station

b2 Subnet mask for the 
Ethernet standard port GOT network number

b3 Use prohibited GOT station number

b4 Default gateway Use prohibited
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When GS1900 stores 5, 6, or 7

• b5 to b15: Use prohibited

(31)New GOT Ethernet Setting (GS1903 to GS1908)
The device that corresponds to the Ethernet setting item to be changed stores a new value.
When the Execute GOT Ethernet Setting Change signal (GS1901.b0) is turned on, the Ethernet setting is updated with 
the new value.
The following shows the correspondence between the devices and the Ethernet setting items.
When GS1900 stores 1, 2, 3 or 4

When GS1900 stores 5, 6, or 7

The following shows how to set a new value.

(a) When the GOT Ethernet Setting Change Category device (GS1900) stores 1
Set new values in hexadecimal for the following items.

GOT GS1902
Ethernet setting item to be changed

When GS1900 stores 5 When GS1900 stores 6 When GS1900 stores 7

All models

b0 Channel number Channel number Channel number

b1
Setting number in the 
connected Ethernet 
controller setting

Setting number in the 
connected Ethernet 
controller setting

Setting number in the 
connected Ethernet 
controller setting

b2 Network number for a 
controller

Station number of a 
controller

IP address of a 
controller

GOT
New GOT 
Ethernet 

Setting device

Ethernet setting item

When GS1900 stores 1 When GS1900 stores 2 When GS1900 stores 3 When GS1900 stores 4

GT27
GT25-S
GT25-V 
(excluding 
GT2505-V)

GS1903 GOT IP address for the 
Ethernet standard port

Channel number GOT IP address for the 
wireless LAN interface

GOT IP address for the 
Ethernet extended portGS1904 Host station

GS1905 Subnet mask for the 
Ethernet standard port

GOT network number Subnet mask for the 
wireless LAN interface

Subnet mask for the 
Ethernet extended portGS1906 GOT station number

GS1907
Default gateway Use prohibited Use prohibited

Setting to disable the 
Ethernet extended port

GS1908 Use prohibited

GT25-W
GS25

GS1903 GOT IP address for 
Ethernet standard port 1

Channel number GOT IP address for the 
wireless LAN interface

GOT IP address for 
Ethernet standard port 2GS1904 Host station

GS1905 Subnet mask for 
Ethernet standard port 1

GOT network number Subnet mask for the 
wireless LAN interface

Subnet mask for 
Ethernet standard port 2GS1906 GOT station number

GS1907
Default gateway Use prohibited Use prohibited

Setting to disable 
Ethernet standard port 2

GS1908 Use prohibited

GT2505-V
GT25HS-V
GT23
GT21
GS21

GS1903 GOT IP address for the 
Ethernet standard port

Channel number

Use prohibited Use prohibited

GS1904 Host station

GS1905 Subnet mask for the 
Ethernet standard port

GOT network number

GS1906 GOT station number

GS1907
Default gateway Use prohibited

GS1908

GOT
New GOT 
Ethernet 

Setting device

Ethernet setting item

When GS1900 stores 5 When GS1900 stores 6 When GS1900 stores 7

All models

GS1903 Channel number Channel number Channel number

GS1904
Setting number in the 
connected Ethernet 
controller setting

Setting number in the 
connected Ethernet 
controller setting

Setting number in the 
connected Ethernet 
controller setting

GS1905 Network number for a 
controller

Station number of a 
controller IP address of a controller

GS1906 Use prohibited Use prohibited
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• GOT IP address for the Ethernet standard port or Ethernet standard port 1
• Subnet mask for the Ethernet standard port or Ethernet standard port 1
• Default gateway

The following shows the setting range of each item. (Decimal)
• GOT IP address: 0.0.0.0 to 223.255.255.255
• Subnet mask and default gateway: 0.0.0.0 to 255.255.255.255

If you do not use the subnet mask or default gateway, set the item to 0.0.0.0.
Example) When the GOT IP address for the Ethernet standard port of GT27 is changed to 192.168.3.18 (decimal)

(b) When the GOT Ethernet Setting Change Category device (GS1900) stores 2
• Channel number

Set the channel number of a controller for which the host station, GOT network number, or GOT station number is 
changed.
The setting range is 1 to 4.

• Host station, GOT network number, and GOT station number
Set the host station, GOT network number, or GOT station number for the controller connected to the specified 
channel.
The following shows the setting range of each item.
Host station: 1 to 128
GOT network number: The setting range depends on the controller used.
GOT station number: The setting range depends on the controller used.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used
To set the host station, specify a setting number existing in the connected Ethernet controller setting.

(c) When the GOT Ethernet Setting Change Category device (GS1900) stores 3
Set the GOT IP address or subnet mask for the wireless LAN interface in hexadecimal.
The following shows the setting range of each item. (Decimal)

• GOT IP address: 0.0.0.0 to 223.255.255.255
• Subnet mask: 0.0.0.0 to 255.255.255.255

If you do not use the subnet mask, set the item to 0.0.0.0.
Example) When the GOT IP address for the wireless LAN interface of GT27 is changed to 192.168.4.20 (decimal)

(d) When the GOT Ethernet Setting Change Category device (GS1900) stores 4
Set the GOT IP address or subnet mask for the Ethernet extended port or Ethernet standard port 2 in hexadecimal with 
GS1903 to GS1906.
The following shows the setting range of each item. (Decimal)

• GOT IP address: 0.0.0.0 to 223.255.255.255

GOT IP address: C0. A8. 03. 12 (Hexadecimal)

GS1903

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1904

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

GOT IP address: C0. A8. 04. 14 (hexadecimal)

GS1903

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1904

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
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• Subnet mask: 0.0.0.0 to 255.255.255.255
If you do not use the subnet mask, set the item to 0.0.0.0.

Example) When the GOT IP address for the Ethernet extended port of GT27 is changed to 192.168.3.18 (decimal)

Set whether to disable the Ethernet extended port or Ethernet standard port 2 with GS1907.
To disable the Ethernet extended port or Ethernet standard port 2, turn on GS1907.b0.

(e) When the GOT Ethernet Setting Change Category device (GS1900) stores 5

• Channel number and the setting number in the connected Ethernet controller setting
Set the channel number and setting number of a controller for which the network number is changed.
The following shows the setting range of each item.
Channel number: 1 to 4
Setting number in the connected Ethernet controller setting: 1 to 128

• Network number for a controller
Set the network number for a controller.
The setting range varies with the controller.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

(f) When the GOT Ethernet Setting Change Category device (GS1900) stores 6

• Channel number and the setting number in the connected Ethernet controller setting
Set the channel number and setting number of a controller whose station number is changed.
The following shows the setting range of each item.
Channel number: 1 to 4
Setting number in the connected Ethernet controller setting: 1 to 128

• Station number of a controller
Set the station number of a controller.
The setting range varies with the controller.
For details, refer to the following.

➟GOT2000 Series Connection Manual for a controller used

GOT IP address: C0. A8. 03. 12 (hexadecimal)

GS1903

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1904

Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Setting number

Setting number
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(g) When the GOT Ethernet Setting Change Category device (GS1900) stores 7

• Channel number and the setting number in the connected Ethernet controller setting
Set the channel number and setting number of a controller whose IP address is changed.
The following shows the setting range of each item.
Channel number: 1 to 4
Setting number in the connected Ethernet controller setting: 1 to 128

• IP address of a controller
Set the IP address of a controller in hexadecimal.
The setting range is 0.0.0.0 to 223.255.255.255 (decimal).
Example) When the IP address of a controller is changed to 192.168.3.45 (decimal)

(32)Full-screen Display Control signal (GS1998)
When the Extended Control signal (b7) of the video and RGB input common device is on, the Full-screen Display Control 
signal specifies the video window or the RGB screen to be displayed in full-screen size.
For the setting other than the following values, the operation is the same as when 0 is stored.
0: Does not display the video window in full-screen size. (The size of the video window or the RGB screen corresponds 
to the setting of each video window or the RGB screen.)
1 to 4: Displays the specified number of video window in full-screen size.
5: Displays the RGB screen in full-screen size.

(33)Video Window 1 to 4 and RGB Screen Extended Control signal (GS1999 to GS2006, GS2009 to 
GS2016, GS2019 to GS2026, GS2029 to GS2036, GS2039 to GS2045)
While the Extended Control signal (b7) of the video and RGB input common device is on, configure the setting for video 
windows 1 to 4 or the RGB screen.
The default display position of the video window is the upper left corner of the GOT screen.

Setting number

Controller IP address: C0. A8. 03. 2D (hexadecimal)

GS1905
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 GS1906
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Device
Function

Video window 1 Video window 2 Video window 3 Video window 4 RGB window

GS1999 GS2009 GS2019 GS2029 *1 Specify the channel No. of the video window.

GS2000 GS2010 GS2020 GS2030 GS2039

Specify the display magnification of the video window or 
RGB screen.
The display size, which is specified in the display size 
setting (width and height) for the video window or RGB 
screen, is used as the reference.
• 7: 400%
• 8: 200%
• 0: 100%
• 1: 87.5%
• 2: 75%
• 3: 62.5%
• 4: 50%
• 5: 37.5%
• 6: 25%
• Other than the above: 100%
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*1 Specify a channel number with b14 and b15 of the device specified for [Video/RGB Input Common].

➟10.6.4 ■8 Setting items of [Video/RGB Input Common] device

GS2001 GS2011 GS2021 GS2031 GS2040

Specify the display size (width) of the video window or 
RGB screen in dots by using the size at 100% 
magnification as the reference.
The actual display size (width) of the video window or 
RGB screen is enlarged or reduced according to the set 
display magnification.
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2002 GS2012 GS2022 GS2032 GS2041

Specify the display size (height) of the video window or 
RGB screen in dots by using the size at 100% 
magnification as the reference.
The actual display size (height) of the video window or 
RGB screen is enlarged or reduced according to the set 
display magnification.
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2003 GS2013 GS2023 GS2033 GS2042

Using the upper left corner of the GOT screen as the 
origin point of coordinates, specify the display position 
(X coordinate) of the video window or RGB screen in 
dots.
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2004 GS2014 GS2024 GS2034 GS2043

Using the upper left corner of the GOT screen as the 
origin point of coordinates, specify the display position 
(Y coordinate) of the video window or RGB screen in 
dots.
Specify the display magnification within a range of the 
lower resolution in the video image or the GOT.

GS2005 GS2015 GS2025 GS2035 GS2044

Specify the origin point (X coordinate) of the clip area of 
the video image.
Specify the display magnification within a range of the 
resolution of the video image.

GS2006 GS2016 GS2026 GS2036 GS2045

Specify the origin point (Y coordinate) of the clip area of 
the video image.
Specify the display magnification within a range of the 
resolution of the video image.

Device
Function

Video window 1 Video window 2 Video window 3 Video window 4 RGB window
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12.2 Correspondence between the setting of [Controller Type] and the 
controller used

Set [Manufacturer] and [Controller Type] in the [Controller Setting] window according to the controller to be used.
The following shows the supported controllers and the corresponding settings of [Manufacturer] and [Controller Type] in the 
[Controller Setting] window.

➟■1 [MITSUBISHI ELECTRIC]
■2 [IAI]
■3 [Azbil]
■4 [OMRON]
■5 [KEYENCE]
■6 [KOYO]
■7 [JTEKT]
■8 [SHARP]
■9 [SHINKO]
■10 [CHINO]
■11 [TOSHIBA]
■12 [SHIBAURA MACHINE]
■13 [PANASONIC]
■14 [HITACHI]
■15 [Hirata HNC]
■16 [FUJI]
■17 [Muratec]
■18 [YASKAWA]
■19 [YOKOGAWA]
■20 [RKC]
■21 [AB]
■22 [GE]
■23 [LS IS]
■24 [Mitsubishi Electric India]
■25 [SICK]
■26 [SIEMENS]
■27 [CLPA]
■28 [MODBUS]
■29 [ODVA]
■30 [OPC]
■31 [PROFIBUS]
■32 [Others]
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■1 [MITSUBISHI ELECTRIC]
Set the channel of the controller to be connected with the GOT.

(1) Setting
Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Refer to the following to configure the settings.

Channel No. 2 to 4
Set channel No. 2 to 4 when using the multi-channel function.
For the details of the multi-channel function, refer to the following.
➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

(2) Setting item
The following shows the setting items.

1) [Manufacturer]
Select [MITSUBISHI ELECTRIC].
Select the manufacturer of the controller connected to the GOT.

4)

1)

3)
2)

5)
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2) [Controller Type]
The following table lists available controllers.

Controller type Model name

[MELSEC iQ-R, RnMT/NC/RT, CR800-D]

R00CPU, R01CPU, R02CPU, R04CPU, R08CPU, R16CPU, R32CPU, R120CPU
R16MTCPU, R32MTCPU, R64MTCPU
R08PCPU, R16PCPU, R32PCPU, R120PCPU
R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU
R08PSFCPU, R16PSFCPU, R32PSFCPU, R120PSFCPU
R04ENCPU, R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU
R12CCPU-V
R102WCPU-W

MR-J5-G(-RJ)*2

MR-J5W2-G*2

MR-J5W3-G*2

MR-J5D□-G*2

MR-J5(W)-□B(-RJ)*1

MR-J4(W)-*B(-RJ) *1

MR-J4-GF(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

MR-JET-G*2

CNC C80(R16NCCPU-S1)
CR800-R(R16RTCPU), CR800-D
FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0-NE
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[MELSEC iQ-R, RnMT/RT, CR800-D]

R00CPU, R01CPU, R02CPU, R04CPU, R08CPU, R16CPU, R32CPU, R120CPU
R16MTCPU, R32MTCPU, R64MTCPU
R08PCPU, R16PCPU, R32PCPU, R120PCPU
R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU
R04ENCPU, R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU
R12CCPU-V
R102WCPU-W

MR-J5-G(-RJ)*2

MR-J5W2-G*2

MR-J5W3-G*2

MR-J5D□-G*2

MR-J5(W)-□B(-RJ)*1

MR-J4(W)-*B(-RJ) *1

MR-J4-GF(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

MR-JET-G*2

CR800-R(R16RTCPU), CR800-D
FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0-NE

[MELSEC iQ-L]

L04HCPU, L08HCPU, L16HCPU, L32HCPU

MR-J4(W)-*B(-RJ) *1

MR-J4-GF(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

[MELSEC iQ-F]

FX5U
FX5UC
FX5UJ
FX5S

MR-J5-G(-RJ)*2

MR-J5W2-G*2

MR-J5W3-G*2

MR-J4(W)-*B(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

MR-JET-G*2

Controller type Model name
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[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]

Q00JCPU
Q00CPU, Q01CPU, Q02CPU
Q02HCPU, Q06HCPU, Q12HCPU, Q25HCPU
Q02PHCPU, Q06PHCPU, Q12PHCPU, Q25PHCPU
Q12PRHCPU, Q25PRHCPU
Q172CPU, Q173CPU
Q172CPUN, Q173CPUN
Q172HCPU, Q173HCPU
Q00UJCPU, Q00UJCPU-S8
Q00UCPU, Q01UCPU, Q02UCPU
Q03UDCPU
Q04UDHCPU, Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU
Q03UDECPU
Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU
Q20UDEHCPU, Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU
Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU
Q04UDPVCPU, Q06UDPVCPU, Q13UDPVCPU, Q26UDPVCPU
Q12DCCPU-V, Q24DHCCPU-V, Q24DHCCPU-LS, Q26DHCCPU-LS, Q24DHCCPU-VG
QS001CPU
Q172DCPU, Q173DCPU, Q172DCPU-S1, Q173DCPU-S1,
Q172DSCPU, Q173DSCPU
Q170MCPU, Q170MSCPU, Q170MSCPU-S1
MR-MQ100
CNC C70(Q173NCCPU)
CRnQ-700(Q172DRCPU), CR750-Q(Q172DRCPU), CR751-Q(Q172DRCPU)
CR800-Q(Q172DSRCPU)
CRnD-700, CR75 0-D, CR75 1-D

MR-J5(W)-□B(-RJ) *1

MR-J4(W)-*B(-RJ) *1

MR-J4-GF(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0-NE

Controller type Model name
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[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]

Q00JCPU
Q00CPU, Q01CPU, Q02CPU
Q02HCPU, Q06HCPU, Q12HCPU, Q25HCPU
Q02PHCPU, Q06PHCPU, Q12PHCPU, Q25PHCPU
Q12PRHCPU, Q25PRHCPU
Q00UJCPU, Q00UJCPU-S8
Q00UCPU, Q01UCPU, Q02UCPU
Q03UDCPU
Q04UDHCPU, Q06UDHCPU, Q10UDHCPU, Q13UDHCPU
Q20UDHCPU, Q26UDHCPU
Q03UDECPU
Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU
Q20UDEHCPU, Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU
Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU
Q04UDPVCPU, Q06UDPVCPU, Q13UDPVCPU, Q26UDPVCPU
Q12DCCPU-V, Q24DHCCPU-V, Q24DHCCPU-LS, Q26DHCCPU-LS, Q24DHCCPU-VG
Q172CPU, Q173CPU
Q172CPUN, Q173CPUN
Q172HCPU, Q173HCPU
Q172DCPU, Q173DCPU, Q172DCPU-S1, Q173DCPU-S1
Q172DSCPU, Q173DSCPU
Q170MCPU, Q170MSCPU, Q170MSCPU-S1
MR-MQ100
CRnQ-700(Q172DRCPU), CR750-Q(Q172DRCPU), CR751-Q(Q172DRCPU)
CR800-Q(Q172DSRCPU)
CRnD-700, CR75 0-D, CR75 1-D
MR-J5(W)-□B(-RJ) *1

FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0-NE

[MELSEC-QnA, MELDAS C6*]
Q2ACPU, Q2ACPU-S1, Q3ACPU, Q4ACPU, Q4ARCPU
Q2ASCPU, Q2ASCPU-S1, Q2ASHCPU, Q2ASHCPU-S1
MELDAS C6(FCA C6), MELDAS C64(FCA C64)

[MELSEC-QnA]
Q2ACPU, Q2ACPU-S1, Q3ACPU, Q4ACPU, Q4ARCPU
Q2ASCPU, Q2ASCPU-S1, Q2ASHCPU, Q2ASHCPU-S1

Controller type Model name
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[MELSEC-L]

L02CPU, L06CPU, L26CPU, L26CPU-BT
L02CPU-P, L06CPU-P, L26CPU-P, L26CPU-PBT
L02SCPU, L02SCPU-P
NZ2GF-ETB
MR-J4(W)-*B(-RJ) *1

MR-J4-GF(-RJ) *1

MR-JE-*B *1

MR-JE-*BF *1

FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0-NE

[MELSEC-A]

A2UCPU, A2UCPU-S1, A3UCPU, A4UCPU
A2ACPU, A2ACPUP21, A2ACPUR21, A2ACPU-S1, A2ACPUP21-S1, A2ACPUR21-S1
A3ACPU, A3ACPUP21, A3ACPUR21
A1NCPU, A1NCPUP21, A1NCPUR21
A2NCPU, A2NCPUP21, A2NCPUR21, A2NCPU-S1, A2NCPUP21-S1, A2NCPUR21-S1
A3NCPU, A3NCPUP21, A3NCPUR21
A2USCPU, A2USCPU-S1, A2USHCPU-S1
A1SCPU, A1SCPUC24-R2, A1SHCPU
A2SCPU, A2SHCPU
A1SJCPU, A1SJCPU-S3, A1SJHCPU
A0J2HCPU, A0J2HCPUP21, A0J2HCPUR21, A0J2HCPU-DC24
A2CCPU, A2CCPUP21, A2CCPUR21, A2CCPUC24
A2CCPUC24-PRF, A2CJCPU-S3
A1FXCPU
A273UCPU, A273UHCPU, A273UHCPU-S3
A373UCPU, A373UCPU-S3
A171SCPU, A171SCPU-S3, A171SCPU-S3N
A171SHCPU, A171SHCPUN
A172SHCPU, A172SHCPUN, A173UHCPU

[MELSEC-FX]

FX0, FX0S, FX0N
FX1, FX1S, FX1N, FX1NC
FX2, FX2C, FX2N, FX2NC
FX3S, FX3G, FX3GC, FX3GE, FX3U, FX3UC

[MELSEC-WS] WS0-CPU0, WS0-CPU1, WS0-CPU3

[MELIPC] MI5122-VW

[MELSERVO-J2M-P8A] MR-J2M-P8A

[MELSERVO-J2M-*DU] MR-J2M-*DU

[MELSERVO-J2S-*A] MR-J2S-*A

[MELSERVO-J2S-*CP] MR-J2S-*CP

[MELSERVO-J2S-*CL] MR-J2S-*CL

[MELSERVO-J3-*A] MR-J3-*A

[MELSERVO-J3-*T] MR-J3-*T

[MELSERVO-J4-*A, -JE-*A] MR-J4-*A, MR-JE-*A

[MELSERVO-J4-*A-RJ] MR-J4-*A-RJ

[MELSERVO-JE-*C] MR-JE-*C

Controller type Model name
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[MELSERVO-J5(W)-*G(-RJ), -JET-*G]

MR-J5-G(-RJ)
MR-J5W2-G
MR-J5W3-G
MR-JET-G
MR-J5D□-G

[FREQROL 500/700/800, SENSORLESS SERVO]

FR-A5□0(L)
FR-F5□0(L)
FR-V5□0(L)
FR-E5□0(C), FR-E5□0S, FR-E5□0W
FR-S5□0(E)(-R)(-C), FR-S5□0S(E)(-R), FR-S5□0W(E)(-R)
FR-F5□0J(F)
FR-D7□0, FR-D7□0S, FR-D7□0W
FR-F7□0PJ(F)
FR-E7□0, FR-E7□0S, FR-E7□0W
FR-A7□0
FR-B-□□□□ (A700 specification)
FR-B3-(N)(H)□□□□ (A700 specification)
FR-B-□□□□ (A800 specification)
FR-B3-(N)(H)□□□□ (A800 specification)
FR-F7□0
FR-F7□0P
FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E
FR-E7□0EX
MD-CX522-□K
MD-CX522-□K-A0

[FREQROL 800]

FR-B-□□□□ (A800 specification)
FR-B3-(N)(H)□□□□ (A800 specification)
FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E

Controller type Model name
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*1 The controller is connectable to the GOT through a motion controller or a simple motion module.
*2 The controller is connectable to the GOT through a Motion module.

3) [I/F]
Available interfaces differ depending on the GOT used.
Set [I/F] according to the interface used and the position of the communication unit mounted on the GOT.

4) [Detail Setting]
Configure the settings including the baud rate and the data length of the communication driver used.

5) [Driver]
This item appears when communication drivers are selectable according to the settings of [Controller Type] and [I/
F].
Select the communication driver to be written to the GOT.
Refer to the following to configure the setting.

➟GOT2000 Series Connection Manual (Mitsubishi Products) for GT Works3 Version1

[FREQROL 800/E700NE(Batch monitor)]

FR-E7□0-NE
FR-A8□0, FR-A8□2, FR-A8□6
FR-A8□0-E, FR-A8□2-E, FR-A8□6-E
FR-A8□0-GF, FR-A8□2-GF
FR-A8□0-CRN, FR-A8□2-CRN
FR-A8□0-E-CRN, FR-A8□2-E-CRN
FR-A8□0-R2R, FR-A8□2-R2R
FR-A8□0-E-R2R, FR-A8□2-E-R2R
FR-A8□0-GN, FR-A8□2-GN
FR-A8□0-AWH
FR-A8□0-E-AWH
FR-A8□0-LC
FR-A8□0-E-LC
FR-F8□0, FR-F8□2, FR-F8□6
FR-F8□0-E, FR-F8□2-E
FR-E8□0, FR-E8□0-E

[Laser Displacement Sensor MH11] MH11CTMF-N, MH11CTMF-NNA, MH11CTMF-P, MH11CTMF-PNA

Controller type Model name

Extension interface

Extension interface 1
(RS-232 interface built in the GOT)

Extension interface 2
(USB interface built in the GOT)

(Example: In the case of the GT27)

Extension interface 3
(RS-422/485 interface built in the GOT)

Extension interface 4
(Ethernet interface built in the GOT)

3rd stage

2nd stage

1st stage
12. APPENDICES
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■2 [IAI]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [IAI]
• [Controller Type]

When connecting to X-SEL, SSEL, ASEL, or PSEL: [IAI X-SEL Controller]
When connecting to PCON, ACON, SCON, or ERC2: [IAI ROBO CYLINDER]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

Click!
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■3 [Azbil]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [Azbil]
• [Controller Type]

When connecting to DMC50 or AHC2001: [Azbil DMC50]
When connecting to the models other than DMC50]: [Azbil SDC/DMC]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■4 [OMRON]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [OMRON]
• [Controller Type]: select either of the following according to the model to be connected.

[OMRON SYSMAC]
[OMRON NJ/NX]
[OMRON THERMAC/INPANEL NEO]
[OMRON Digital Temperature Controller]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
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■5 [KEYENCE]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [KEYENCE]
• [Controller Type]: [KEYENCE  KV-700/1000/3000/5000/7000/8000]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■6 [KOYO]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [KOYO]
• [Controller Type]: [KOYO KOSTAC/DL]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
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■7 [JTEKT]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [JTEKT]
• [Controller Type]: [JTEKT TOYOPUC-PC]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■8 [SHARP]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [SHARP]
• [Controller Type]: [SHARP JW]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
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■9 [SHINKO]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [SHINKO]
• [Controller Type]: [Shinko Technos Controller]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■10 [CHINO]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [CHINO]
• [Controller Type]: [CHINO MODBUS device]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
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■11 [TOSHIBA]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [TOSHIBA]
• [Controller Type]: select either of the following according to the model to be connected.

[TOSHIBA PROSEC T/V]
[TOSHIBA Unified Controller nv]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■12 [SHIBAURA MACHINE]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [SHIBAURA MACHINE]
• [Controller Type]: [SHIBAURA MACHINE TCmini]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

2.

3.

Click!
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■13 [PANASONIC]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [Panasonic]
• [Controller Type]: select either of the following according to the model to be connected.

[Panasonic MEWNET-FP]
[Panasonic FP7]
[Panasonic MINAS A4]
[Panasonic MINAS A5]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 1) for GT Works3 Version1

Click!

2.

3.
12. APPENDICES
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■14 [HITACHI]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [HITACHI]
• [Controller Type]: select either of the following according to the model to be connected.

[HITACHI IES EHV]
[HITACHI IES HIDIC H]
[HITACHI S10VE]
[HITACHI S10mini/S10V]

• [I/F]: The interface to be used
• [Driver]: This item appears when [Controller Type] is set to [HITACHI HIDIC H].

[HITACHI IES HIDIC H]
[HITACHI IES HIDIC H(Protocol2)]

• [Detail Setting]: Configure the settings according to the use environment.
Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

■15 [Hirata HNC]
For the setting details, contact our company.

2.

3.

Click!
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■16 [FUJI]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [FUJI]
• [Controller Type]: select either of the following according to the model to be connected.

[FUJI MICREX-F]
[FUJI Temperature Controller/Digital Controller]
[FUJI MICREX-SX SPH]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

■17 [Muratec]
For the setting details, contact our company.

2.

3.

Click!
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■18 [YASKAWA]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [YASKAWA]
• [Controller Type]: select either of the following according to the model to be connected.

[YASKAWA GL/PROGIC8]
[YASKAWA CP9200(H)]
[YASKAWA CP9300MS(MC compatible)]
[YASKAWA MP2000/MP900/CP9200SH]
[YASKAWA MP3000]
[YASKAWA Robot Controller]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
12 - 128 12. APPENDICES
12.2 Correspondence between the setting of [Controller Type] and the controller used



A
PP

EN
D

IC
ES

12
■19 [YOKOGAWA]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [YOKOGAWA]
• [Controller Type]: select either of the following according to the model to be connected.

[YOKOGAWA STARDOM/FA500/FA-M3]
[YOKOGAWA GREEN/UT100/UT2000/UTAdvanced]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■20 [RKC]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [RKC]
• [Controller Type]: [RKC SR Mini HG]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
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■21 [AB]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [AB]
• [Controller Type]: select either of the following according to the model to be connected.

[AB SLC500]
[AB MicroLogix]
[AB MicroLogix (Extended)]
[AB Control/CompactLogix]
[AB Control/CompactLogix(Tag)]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■22 [GE]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [GE]
• [Controller Type]: [GE Series 90]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
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■23 [LS IS]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [LS IS]
• [Controller Type]: select either of the following according to the model to be connected.

[LS Industrial Systems XGK]
[LS Industrial Systems MASTER-K]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.
• [Connected Ethernet Controller Setting]: Register the controller to be connected.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
12. APPENDICES
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■24 [Mitsubishi Electric India]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [Mitsubishi Electric India]
• [Controller Type]: [MEI Nexgenie]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
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■25 [SICK]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [SICK]
• [Controller Type]: [SICK Flexi Soft]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
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■26 [SIEMENS]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [SIEMENS]
• [Controller Type]: select either of the following according to the model to be connected.

[SIEMENS S7-200]
[SIEMENS S7-200(CN/SMART)]
[SIEMENS S7-300/400]
[SIEMENS S7(Ethernet)]
[SIEMENS OP(Ethernet)]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Non-Mitsubishi Products 2) for GT Works3 Version1

2.

3.

Click!
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■27 [CLPA]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [CLPA]
• [Controller Type]: select either of the following according to the model to be connected.

[CC-Link IE Field Network Basic]
[SLMP]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 

Works3 Version1

2.

3.

Click!
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■28 [MODBUS]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [MODBUS]
• [Controller Type]: select one of the following items according to the controller to be connected.

[MODBUS Slave(GOT:Master)]
[MODBUS Master(GOT:Slave)]

• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 

Works3 Version1

2.

3.

Click!
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■29 [ODVA]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [ODVA]
• [Controller Type]: [DeviceNet]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 

Works3 Version1

2.

3.

Click!
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■30 [OPC]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [OPC]
• [Controller Type]: [OPC UA]

Step 4 When you have completed the setting, click the [OK] button.

2.

3.

Click!
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■31 [PROFIBUS]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [PROFIBUS]
• [Controller Type]: [PROFIBUS DP]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 

Works3 Version1

2.

3.

Click!
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■32 [Others]
Set the channel of the controller to be connected with the GOT.

Step 1 Select [Common] → [Controller Setting] from the menu.
Step 2 The [Controller Setting] window appears. select the channel No. to be used from the list menu.
Step 3 Set the following items.

• [Manufacturer]: [Other]
• [Controller Type]: [Computer]
• [I/F]: The interface to be used
• [Detail Setting]: Configure the settings according to the use environment.

Step 4 When you have completed the setting, click the [OK] button.

The controller setting can be checked in [I/F Communication Setting].
For details, refer to the following.
➟GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) For GT 

Works3 Version1

2.

3.

Click!
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12.3 Device Range and Settings of Mitsubishi Electric Equipment
This section describes the range of devices settable in GT Designer3 for each of Mitsubishi Electric products connected 
to the GOT.
The settable range varies with the selection for [Controller Type] in the [Controller Setting] window.
Configure the device setting according to the specifications of the controller to be used.
Device specifications differ depending on the controller model even among the controllers of the same series.
If a non-existent device or a device number out of the range is set for an object, other objects for which correct devices 
are set may not be monitored.

➟12.3.1 Device setting dialog (Mitsubishi Electric equipment)
12.3.2 [MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D]
12.3.3 [MELSEC iQ-L]
12.3.4 [MELSEC iQ-F]
12.3.5 [MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]
12.3.6 [MELSEC QnA, MELDAS C6*]
12.3.7 [MELSEC-L]
12.3.8 [MELSEC-A]
12.3.9 [MELSEC-FX]
12.3.10 [MELSEC-WS]
12.3.11 [MELIPC]
12.3.12 [MELSERVO-J2M-P8A]
12.3.13 [MELSERVO-J2M-*DU]
12.3.14 [MELSERVO-J2S-*A]
12.3.15 [MELSERVO-J2S-*CP]
12.3.16 [MELSERVO-J2S-*CL]
12.3.17 [MELSERVO-J3-*A]
12.3.18 [MELSERVO-J3-*T]
12.3.19 [MELSERVO-J4-*A, -JE-*A]
12.3.20 [MELSERVO-J4-*A-RJ]
12.3.21 [MELSERVO-JE-*C]
12.3.22 [MELSERVO-J5(W)-*G(-RJ), -JET-*G]
12.3.23 [FREQROL 500/700/800, SENSORLESS SERVO]
12.3.24 [FREQROL 800]
12.3.25 [FREQROL 800/E700NE(Batch monitor)]
12.3.26 [Laser Displacement Sensor MH11]
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12.3.1 Device setting dialog (Mitsubishi Electric equipment)

Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X0000

The setting items vary with the selected device name.

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Network]
Set the station number of the controller to be monitored.
The setting items depend on the controller setting.

➟■1 Network setting for connection to the Mitsubishi Electric PLC
■2 Network setting for connection to the Mitsubishi Electric servo amplifier
■3 Network setting for connection to the Mitsubishi Electric inverter

2) 3)

4)

5)

1)

4)

6)

[MELSEC iQ-R, RnMT/NC/RT, CR800-D] [MELSERVO-J4-*A-RJ]

X0000

Device name
Device No.

When [X] is selected for the device name

When [SP] is selected for the device name
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5) [Switch to the device comment dialog] button
You can open the device comment setting dialog to check the device comments imported to GT Designer3.

➟6.1.6 ■5 Device comment setting dialog
6) [Switch to the device define dialog] button

You can open the device definition setting dialog to check the definitions of the virtual servo amplifier or inverter 
devices.

➟6.1.6 ■6 Device definition setting dialog

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

For the specifications of each device, refer to the following.
➟12.3.2 [MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D]

12.3.3 [MELSEC iQ-L]
12.3.4 [MELSEC iQ-F]
12.3.5 [MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]
12.3.6 [MELSEC QnA, MELDAS C6*]
12.3.7 [MELSEC-L]
12.3.8 [MELSEC-A]
12.3.9 [MELSEC-FX]
12.3.10 [MELSEC-WS]
12.3.11 [MELIPC]
12.3.12 [MELSERVO-J2M-P8A]
12.3.13 [MELSERVO-J2M-*DU]
12.3.14 [MELSERVO-J2S-*A]
12.3.15 [MELSERVO-J2S-*CP]
12.3.16 [MELSERVO-J2S-*CL]
12.3.17 [MELSERVO-J3-*A]
12.3.18 [MELSERVO-J3-*T]
12.3.19 [MELSERVO-J4-*A, -JE-*A]
12.3.20 [MELSERVO-J4-*A-RJ]
12.3.21 [MELSERVO-JE-*C]
12.3.22 [MELSERVO-J5(W)-*G(-RJ), -JET-*G]
12.3.23 [FREQROL 500/700/800, SENSORLESS SERVO]
12.3.24 [FREQROL 800]
12.3.25 [FREQROL 800/E700NE(Batch monitor)]
12.3.26 [Laser Displacement Sensor MH11]
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■1 Network setting for connection to the Mitsubishi Electric PLC
Configure the following settings for connecting to a Mitsubishi Electric PLC.
Example) Device setting dialog for [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

1) [CPU No.]
Set the CPU number of the controller.

➟(1) Setting the CPU No.
2) Station type specification

Select the station type (host or other) for the controller to be monitored.
• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

When monitoring link relay (B) and link register (W) assigned in link parameter and network parameter, select 
[Host].
If [Other] is selected, the cyclic transmission will be changed to the transient transmission irrespective of the 
network type, resulting in delay of the object display.
Set RX, RY, RWw, RWr, LB, or LW as [Host] when monitoring a cyclic device.

3) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

4) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

5) [Control System/Standby System]
This item can be set only when [Use the function of MELSEC Redundant] is selected in [MELSEC Redundant] of 
the [Controller Setting] window.
The following shows the items to be selected.

• [Control System]
• [Standby System]

Example) Display terminology of the control system

➟5.5.3 Configuring the setting of the MELSEC redundant function

(1) Setting the CPU No.

1)
2)

3)
4)

5)

[-S] is displayed for a device of the standby system.

1-1/1-S W0.b0
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The setting range depends on the system configuration of the monitoring target.

To specify a CPU number with the value of a GOT data register (GD), refer to the following.
➟(2) Indirect specification of a CPU number

(2) Indirect specification of a CPU number
To set a GOT data register (GD) to specify a CPU number, set [CPU No. switching GD device first No. (3 points)] in the 
[Controller Setting] window.

➟5.5.1 ■4 [Controller Setting]
In GT SoftGOT2000, set [CPU No. switching GD device first No. (3 points)] in the [Communication Setup] dialog.

➟GT SoftGOT2000 Version1 Operating Manual
The following shows the correspondence between CPU numbers and GOT data registers (GD).
Example) When 500 is set to [CPU No. switching GD device first No. (3 points)]
Three consecutive devices, starting from GD500, are set to specify CPU numbers.

Upon the GOT startup, 0 is stored in the specified GD devices until values are set.
If you set the GD devices on the screen that appears upon the GOT startup, a communication timeout error occurs.
To avoid such situation, set the GD devices so that their values are retained at a power failure.

➟5.2.12 Configuring the settings for retaining GOT internal device data at power failure ([Internal Device 
Retention])

When specifying GD devices for multiple channels, set different GD devices to [CPU No. switching GD device first No. 
(3 points)].

GD10 to GD25 are used to specify the monitoring targets, such as the station number of an inverter.
When setting GD devices for a different channel, set different GD devices to [CPU No. switching GD device first No. (3 
points)].

Do not change the value of the specified device while a touch switch with the bit momentary is being pressed.
Doing so may cause the touch switch to exhibit unintended behavior.

Item Description

When monitoring a single CPU system Set the CPU No. to [0].

When monitoring a multiple CPU system Set the CPU No. to any of [1] to [4].

When GT SoftGOT2000 on the PC CPU module is 
connected using the bus connection

Do not specify 0 for [CPU No.].
When 0 is specified, the monitoring target is set to the PC CPU module that cannot be 
monitored.

When monitoring an inverter Set the CPU No. to [0].

CPU number GOT data registers (GD) Setting range

100 GD500
[1] to [4]
(Setting an invalid value causes a communication timeout error.)

101 GD501

102 GD502
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■2 Network setting for connection to the Mitsubishi Electric servo amplifier
Example) Device setting dialog of [MELSERVO-J4-*A-RJ]

1) Monitor target specification
Set the monitoring target of the set device.

2) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [31] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number (for connection to a servo amplifier)
For the network settings of [MELSERVO-JE-*C] and [MELSERVO-J5(W)-*G(-RJ), -JET-*G], refer to the following.

➟(2) For the network settings for [MELSERVO-JE-*C] and [MELSERVO-J5(W)-*G(-RJ), -JET-*G]

(1) Indirect specification of a station number (for connection to a servo amplifier)
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

(2) For the network settings for [MELSERVO-JE-*C] and [MELSERVO-J5(W)-*G(-RJ), -JET-*G]

Item Description

[All]

Select this item when writing data to all servo amplifiers connected.
During a monitoring, the servo amplifier of the station No. 0 is monitored.
When inputting data by the numerical input, the data is written to all servo amplifiers 
connected during inputting and the servo amplifier of the station No. 0 is monitored during 
other than inputting (displaying).
When [All] is selected for a device, network No. 0 and station No. FF are displayed in the 
device list window and the printed report.

[Selection] Specify the station number of a servo amplifier to be monitored.

1) 2)

Station No. GOT data registers (GD) Setting range

100 GD10

[0] to [31]
Setting a value outside the range causes a timeout error.

101 GD11

: :

114 GD24

115 GD25

1) 2)
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1) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

2) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

■3 Network setting for connection to the Mitsubishi Electric inverter
➟(1) Network setting for [FREQROL 500/700/800, SENSORLESS SERVO]

(3) Network setting for [FREQROL 800]
(4) Network setting for [FREQROL 800/E700NE(Batch monitor)]

(1) Network setting for [FREQROL 500/700/800, SENSORLESS SERVO]

1) [Station No.]
Set the station number of the inverter to be monitored.
The setting range is [0] to [31] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(2) Indirect specification of a station number (for connecting an inverter)

(2) Indirect specification of a station number (for connecting an inverter)
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

Do not change the value of the specified device while a touch switch with the bit momentary is being pressed.
Doing so may cause the touch switch to exhibit unintended behavior.

(3) Network setting for [FREQROL 800]

1)

Station No. GOT data registers (GD) Setting range

100 GD10

[0] to [31]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

1)

2)
3)
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1) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

2) [Network No.]
This item appears when [Other] is selected for the station type.
The setting depends on the connection type between the GOT and the inverter.

3) [Station No.]
This item appears when [Other] is selected for the station type.
Set the station number of the inverter to be monitored.
The setting depends on the connection type between the GOT and the inverter.

(4) Network setting for [FREQROL 800/E700NE(Batch monitor)]

1) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

2) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.
The setting range is [1] to [239].

3) [Station No.]
This item appears when [Other] is selected for the station type.
Set the station number of the inverter to be monitored.
The setting range is [1] to [120].

Connection type Description

Serial communication connection [Network No.] is not used.

Ethernet connection
Specify a network number.
The setting range is [1] to [239].

Connection type Description

Serial communication connection
The setting range is [0] to [31] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(2) Indirect specification of a station number (for connecting an inverter)

Ethernet connection The setting range is [1] to [120].

1)

2)
3)
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12.3.2 [MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D]

■1 Monitoring-supported bit devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.2 ■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

○: Available
×: Not available

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

➟■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

➟■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

Specifications of word devices

➟■4 Monitoring-supported word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

➟■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

➟■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

Specifications of double-word 
devices

➟■7 Monitoring-supported double-word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

➟■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

➟■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Specifications of virtual servo 
amplifier devices

➟■10 Virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

➟■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

Specifications of virtual inverter 
devices

➟■12 Virtual inverter devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 3FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 3FFF ○ ○

B*4 Link relay Hexadeci
mal 0000000 to 9A61FFF ○ ○

M*4 Internal relay Decimal 0 to 161882111 ○ ○

L Latch relay Decimal 0 to 32767 ○ ○

S*5 Step relay Decimal 0 to 16383 × ×

F Annunciator Decimal 0 to 131071 ○ ○

TC*4 Timer coil Decimal 0 to 8993439 ○
○
(Not usable as 
word data)
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TT*4 Timer contact Decimal 0 to 8993439 ○
○
(Not usable as 
word data)

CC*4 Counter coil Decimal 0 to 8993439 ○
○
(Not usable as 
word data)

CT*4 Counter contact Decimal 0 to 8993439 ○
○
(Not usable as 
word data)

SC*4 Retentive timer coil Decimal 0 to 8993439 ○
○
(Not usable as 
word data)

SS*4 Retentive timer contact Decimal 0 to 8993439 ○
○
(Not usable as 
word data)

SB*4 Link special relay Hexadeci
mal 0000000 to 9A61FFF ○ ○

SM Special relay Decimal 0 to 4095 ○ ○

RX Remote input Hexadeci
mal 0000 to 3FFF ○ ○

RY Remote output Hexadeci
mal 0000 to 3FFF ○ ○

LB Link relay Hexadeci
mal 0000 to 7FFF ○ ○

LTC*4 Long timer coil Decimal 0 to 2529407 ○
○
(Not usable as 
word data)

LTT*4 Long timer contact Decimal 0 to 2529407 ○
○
(Not usable as 
word data)

LCC*4 Long counter coil Decimal 0 to 4761215 ○
○
(Not usable as 
word data)

LCT*4 Long counter contact Decimal 0 to 4761215 ○
○
(Not usable as 
word data)

LSC*4 Long retentive timer coil Decimal 0 to 2529407 ○
○
(Not usable as 
word data)

LSS*4 Long retentive timer contact Decimal 0 to 2529407 ○
○
(Not usable as 
word data)

SAX Safety input relay Hexadeci
mal 0000 to 2FFF × ×

SAY Safety output relay Hexadeci
mal 0000 to 2FFF × ×

SAB Safety link relay Hexadeci
mal 00000 to 9BFFF × ×

SAM Safety internal relay Decimal 0 to 638975 × ×

SATC Safety timer coil Decimal 0 to 35487 × ×

SATT Safety timer contact Decimal 0 to 35487 × ×

SACC Safety counter coil Decimal 0 to 35487 × ×

SACT Safety counter contact Decimal 0 to 35487 × ×

SASC Safety retentive timer coil Decimal 0 to 35487 × ×

SASS Safety retentive timer contact Decimal 0 to 35487 × ×

SASM Safety special relay Decimal 0 to 4095 × ×

BL SFC block Decimal 0 to 319 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
12 - 152 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.2 ■10 Virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-

D])
*3 Virtual inverter device

For the details, refer to the following.
➟12.3.2 ■12 Virtual inverter devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

*4 For the maximum number of devices when an extended SRAM cassette is installed, refer to the following.

➟MELSEC iQ-R CPU Module User's Manual (Application)
*5 If a bit-specified word device is used in the random read processing, GT SoftGOT2000 (Single channel) or GT Simulator3 

uses the value of the bit device in block No. 0 only.

BLS Step relay (block) Decimal

BL(SFC Block No.)-S(Device)
Notation example: BL1-S3
• SFC Block No. (decimal): 0 to 319
• Device (decimal): 0 to 511

× ×

SP*2 Servo amplifier request Decimal

➟12.3.2 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

OM*2 Operation mode selection Decimal
➟12.3.2 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

TMB*2 Instruction demand (for test 
operation) Decimal

➟12.3.2 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

OTI*2 One-touch tuning instruction Decimal
➟12.3.2 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

GFDI*2 Gear failure diagnosis instruction Decimal
➟12.3.2 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

ECCDI*2
Encoder communication circuit 
diagnosis instruction Decimal

➟12.3.2 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

JnX Link input (link direct) Hexadeci
mal

J(Network No.n)-X(Device)
Notation example: J1-X0000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 3FFF

○ ○

JnY Link output (link direct) Hexadeci
mal

J(Network No.n)-Y(Device)
Notation example: J1-Y0000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 3FFF

○ ○

JnB Link relay (link direct) Hexadeci
mal

J(Network No.n)-B(Device)
Notation example: J1-B0000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 7FFF

○ ○

JnSB Link special relay (link direct) Hexadeci
mal

J(Network No.n)-SB(Device)
Notation example: J1-SB000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 000 to FFF

○ ○

IOST*3 I/O terminal monitor Decimal 0 to 127 × ×

CMD*3 Operation command Decimal 0 to 63 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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The bit device status depends on the SFC program status (active or inactive). When the SFC program is inactive, the bit 
device is off (stores 0).

If a step relay (S) is used in the random read processing, specify the relevant step relay (block) (BLS) on GT SoftGOT2000 
or GT Simulator3.

■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (RD77MS).
The following items are displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (RD77GF).

[Master/Motion Module(CCIET)]

Select this item to connect the GOT through the master station on the CC-Link IE TSN 
and a Motion module (RD78G(H)).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.

Device name Device notation and setting range Notation example

SP

[Motion Controller(SSCNET III/H)]
A(Axis No.)-SP(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

A64-SP0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-SP(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A64-SP0

[Master Module(CCIEF)]
SP(Device)
• Device (decimal): 0 to 6

SP0

[Master/Motion Module(CCIET)]

AA(Axis designation)-SP(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

AA3-SP0
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For indirect specification of a module number, axis number, or axis designation, refer to the following.

OM

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OM(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

A64-OM0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

UFF-A64-OM0

[Master Module(CCIEF)]
OM(Device)
• Device (decimal): 0 to 2, 4 to 5

OM0

[Master/Motion Module(CCIET)]

AA(Axis designation)-OM(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 4 to 5

AA3-OM0

TMB

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMB(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

A64-TMB1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

UFF-A64-TMB1

[Master Module(CCIEF)]
TMB(Device)
• Device (decimal): 1 to 6

TMB1

[Master/Motion Module(CCIET)]

AA(Axis designation)-TMB(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 6

AA3-TMB1

OTI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OTI(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A64-OTI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A64-OTI0

[Master Module(CCIEF)]
OTI(Device)
• Device (decimal): 0 to 5

OTI0

[Master/Motion Module(CCIET)]

AA(Axis designation)-OTI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-OTI0

GFDI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-GFDI(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A64-GFDI1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-GFDI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A64-GFDI1

[Master/Motion Module(CCIET)]

AA(Axis designation)-GFDI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-GFDI0

ECCDI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ECCDI(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A64-ECCDI1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ECCDI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A64-ECCDI1

[Master/Motion Module(CCIET)]

AA(Axis designation)-ECCDI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-ECCDI0

Device name Device notation and setting range Notation example
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➟(1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])
(2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

(1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])
To set a GOT data register to specify a module number, set [Module No. switching GD device first No. (16 points)] in the 
[Controller Setting] window.

➟5.5.1 ■4 [Controller Setting]
In GT SoftGOT2000, set [Module No. switching GD device first No. (16 points)] in the [Communication Setup] dialog.

➟GT SoftGOT2000 Version1 Operating Manual
The following shows the correspondence between module numbers and GOT data registers (GD).
Example) When 550 is set to [Module No. switching GD device first No. (16 points)]
Sixteen consecutive devices, starting from GD550, are set to specify module numbers.

Upon the GOT startup, 0 is stored in the specified GD devices until values are set.
If you set the GD devices on the screen that appears upon the GOT startup, module No.0 is monitored unintentionally, 
or a device range error occurs.
To avoid such situation, set the GD devices so that their values are retained at a power failure.

➟5.2.12 Configuring the settings for retaining GOT internal device data at power failure ([Internal Device 
Retention])

When setting GD devices for multiple channels, set different GD devices to [Module No. switching GD device first No. (16 
points)].

GD10 to GD25 are used to specify the monitoring targets, such as the station number of an inverter.
When setting GD devices for a different channel, set different GD devices to [Module No. switching GD device first No. 
(16 points)].

Do not change the value of the specified device while a touch switch with the bit momentary is being pressed.
Doing so may cause the touch switch to exhibit unintended behavior.

(2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])
To use GOT data registers (GD) to specify an axis number or axis designation, set [Servo axis switching GD device first 
No. (16 points)] in the [Controller Setting] window.

➟5.5.1 ■4 [Controller Setting]
In GT SoftGOT2000, set [Servo axis switching GD device first No. (16 points)] in the [Communication Setup] dialog.

➟GT SoftGOT2000 Version1 Operating Manual
The following shows the relationship between the axis number or axis designation and the GOT data register (GD).
Example) When 10 is set to [Servo axis switching GD device first No. (16 points)]
Sixteen consecutive devices, starting from GD10, are set to specify an axis number.

Upon the GOT startup, 0 is stored in the specified GD devices until values are set.

Module No. GOT data registers (GD) Setting range

100 GD550

[000] to [0FF]
([001] to [010] when [MELSEC iQ-F] is selected for [Controller Type] in the 
[Controller Setting] window)
Setting a value outside the above range causes a device range error.

101 GD551

: :

10E GD564

10F GD565

Axis No. or axis 
designation GOT data registers (GD) Setting range

100 GD10 • Axis number
[1] to [64]

• Axis designation
[1]: Single-axis/Axis A
[2]: Axis B
[3]: Axis C

Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25
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If you set the GD devices on the screen that appears upon the GOT startup, a device range error occurs.
To avoid such situation, set the GD devices so that their values are retained at a power failure.

➟5.2.12 Configuring the settings for retaining GOT internal device data at power failure ([Internal Device 
Retention])

When specifying GD devices for multiple channels, set different GD devices to [CPU No. switching GD device first No. 
(3 points)].

GD10 to GD25 are used to specify the monitoring targets, such as the station number of an inverter.
When setting GD devices for a different channel, set different GD devices to [Servo axis switching GD device first No. 
(16 points)].

Do not change the value of the specified device while a touch switch with the bit momentary is being pressed.
Doing so may cause the touch switch to exhibit unintended behavior.

■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/- -/- R/- R/- -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

LB R/W -/- R/W R/W -/-

LTC R/W -/- -/- -/- -/-

LTT R/W -/- -/- -/- -/-

LCC R/W -/- -/- -/- -/-

LCT R/W -/- -/- -/- -/-

LSC R/W -/- -/- -/- -/-

LSS R/W -/- -/- -/- -/-

SAX R/- -/- R/- R/- -/-

SAY R/- -/- R/- R/- -/-

SAB R/- -/- R/- R/- -/-

SAM R/- -/- R/- R/- -/-
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■4 Monitoring-supported word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.2 ■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-
D], [MELSEC iQ-R, RnMT/RT, CR800-D])

○: Available
×: Not available

SATC R/- -/- -/- -/- -/-

SATT R/- -/- -/- -/- -/-

SACC R/- -/- -/- -/- -/-

SACT R/- -/- -/- -/- -/-

SASC R/- -/- -/- -/- -/-

SASS R/- -/- -/- -/- -/-

SASM R/- -/- R/- R/- -/-

BL R/W -/- -/- -/- -/-

BLS R/W -/- -/- -/- -/-

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

GFDI -/W -/- -/- -/- -/-

ECCDI -/W -/- -/- -/- -/-

JnX R/W -/- R/W R/W -/-

JnY R/W -/- R/W R/W -/-

JnB R/W -/- R/W R/W -/-

JnSB R/W -/- R/W R/W -/-

IOST R/- -/- -/- -/- -/-

CMD -/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN*4 Timer current value Decimal 0 to 8993439 ○ ○

CN*4 Counter current value Decimal 0 to 8993439 ○ ○

SN*4 Retentive timer current value Decimal 0 to 8993439 ○ ○

D*4 Data register Decimal 0 to 10117631 ○ ○

SD Special register Decimal 0 to 4095 ○ ○

W*4 Link register Hexadeci
mal 000000 to 9A61FF ○ ○

SW*4 Link special register Hexadeci
mal 000000 to 9A61FF ○ ○

R File register Decimal 0 to 32767 ○ ○

ER Extension file register(Block) Decimal

ER (R block)-(Device)
Notation example: ER255-100
• R block (decimal): 0 to 255
• Device (decimal): 0 to 32767

○ ○

ZR*4 Extension file register Decimal 0 to 10027007 ○ ○
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Z Index register Decimal 0 to 23 ○
○
(Not usable as bit 
data)

G Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-G100
• Unit No. (hexadecimal): 00 to FF
• Device (decimal): 0 to 268435455
For the module No., set the first 2 digits of 
the 3-digit number that represents the start 
I/O number of the buffer memory for the 
intelligent function module.

○ ○

Ww*3 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

Wr*3 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

LW Link register Hexadeci
mal 00000 to 1FFFF ○ ○

# Motion device Decimal 0 to 108287 ○ ○

U3E0*5 Multiple CPU high speed 
transmission memory Decimal 0 to 12287 ○ ○

U3E1*5 Multiple CPU high speed 
transmission memory Decimal 0 to 12287 ○ ○

U3E2*5 Multiple CPU high speed 
transmission memory Decimal 0 to 12287 ○ ○

U3E3*5 Multiple CPU high speed 
transmission memory Decimal 0 to 12287 ○ ○

SATN Safety timer (current value) Decimal 0 to 35487 × ×

SACN Safety counter (current value) Decimal 0 to 35487 × ×

SASN Safety retentive timer (current 
value) Decimal 0 to 35487 × ×

SAD Safety data register Decimal 0 to 39935 × ×

SASD Safety special register Decimal 0 to 4095 × ×

SAW Safety link register Hexadeci
mal 0000 to 9BFF × ×

PA*2 Basic parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PB*2 Gain filter parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PC*2 Extension setting parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PD*2 I/O setting parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PO*2 Option unit parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PS*2 Special parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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PU*2 Multi encoder parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PT*2 Positioning control parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PL*2*6

Motor extension parameter

Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×Linear servo motor/DD motor 
setting parameter

PN*2 Network setting parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PVS*2*7 Position extension parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

ST*2 Status display Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PE*2 Extension setting No.2 parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

PF*2 Extension setting No.3 parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

NPA*2 Network basic parameter Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

ALM*2

Alarm (current alarm J4A extend) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

Alarm (alarm history J4A extend) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

Alarm (alarm history J5G extend) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

POS*2 Point table (position) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

SPD*2 Point table (speed) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

ACT*2 Point table (acceleration time 
constant) Decimal

➟12.3.2 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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DCT*2 Point table (deceleration time 
constant) Decimal

➟12.3.2 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

DWL*2 Point table (dwell) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

AUX*2 Point table (auxiliary function) Decimal

➟12.3.2 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

MCD*2 Point table (M code) Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

MD*2 Machine diagnosis data Decimal

➟12.3.2 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

GFDS*2 Gear failure diagnosis data Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

ECCDS*

2
Encoder communication circuit 
diagnosis data Decimal

➟12.3.2 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

OTS*2 One-touch tuning data Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

DI*2 External Input signal Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

DO*2 External output signal Decimal
➟12.3.2 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

× ×

JnW Link register (link direct) Hexadeci
mal

J(Network No.n)-W(Device)
Notation example: J1-W00000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 00000 to 1FFFF

○ ○

JnSW Link special register (link direct) Hexadeci
mal

J(Network No.n)-SW(Device)
Notation example: J1-SW000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 000 to FFF

○ ○

U3E0G CPU buffer memory access 
device Decimal

U3E0-G(Device)
Notation example: U3E0-G100
• Device (decimal): 0 to 268435455

○ ○

U3E1G CPU buffer memory access 
device Decimal

U3E1-G(Device)
Notation example: U3E1-G100
• Device (decimal): 0 to 268435455

○ ○

U3E2G CPU buffer memory access 
device Decimal

U3E2-G(Device)
Notation example: U3E2-G100
• Device (decimal): 0 to 268435455

○ ○

U3E3G CPU buffer memory access 
device Decimal

U3E3-G(Device)
Notation example: U3E3-G100
• Device (decimal): 0 to 268435455

○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.2 ■10 Virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-

D])
*3 Not available to GT21 and GS21.
*4 For the maximum number of devices when an extended SRAM cassette is installed, refer to the following.

➟MELSEC iQ-R CPU Module User's Manual (Application)
*5 For monitoring the multiple CPU high speed transmission memory, the CPU buffer memory access device (HG) for RCPU 

is monitored.
The CPU buffer memory access device (G) is not monitored.

*6 The device name depends on the servo amplifier.
MR-J5-G(-RJ) or MR-J5W□-G: Motor extension parameter
Other than MR-J5-G(-RJ) or MR-J5W□-G: Linear servo motor/DD motor setting parameter

*7 PVS is a virtual device corresponding to the servo parameter (PV) of MR-J5-G(-RJ), MR-J5W□-G, and MR-JET-G.
Use the virtual device (PVS) to read/write data from/to the servo parameter (PV).

■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

RD Refresh data register Decimal 0 to 1048575 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (RD77MS).
The following items are displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (RD77GF).

[Master/Motion Module(CCIET)]

Select this item to connect the GOT through the master station on the CC-Link IE TSN 
and a Motion module (RD78G(H)).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.
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The following shows the notation and setting range of virtual devices.

Device name Device notation and setting range Notation example

PA

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PA(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

A64-PA1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PA(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

UFF-A64-PA1

[Master Module(CCIEF)]
PA (Device)
• Device (decimal): 1 to 44, 1001 to 1044

PA1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PA(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

AA3-PA1

PB

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PB(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 92, 1001 to 1092

A64-PB1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 92, 1001 to 1092

UFF-A64-PB1

[Master Module(CCIEF)]
PB(Device)
• Device (decimal): 1 to 92, 1001 to 1092

PB1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PB(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 92, 1001 to 1092

AA3-PB1

PC

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PC(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 90, 1001 to 1090

A64-PC1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PC(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 90, 1001 to 1090

UFF-A64-PC1

[Master Module(CCIEF)]
PC(Device)
• Device (decimal): 1 to 90, 1001 to 1090

PC1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PC(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

AA3-PC1

PD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PD(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

A64-PD1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

UFF-A64-PD1

[Master Module(CCIEF)]
PD(Device)
• Device (decimal): 1 to 72, 1001 to 1072

PD1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

AA3-PD1
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PO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PO(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 2, 1001 to 1002

A64-PO1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 2, 1001 to 1002

UFF-A64-PO1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 2, 1001 to 1002

AA3-PO1

PS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PS(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

A64-PS1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

UFF-A64-PS1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

AA3-PS1

PU

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PU(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

A64-PU1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PU(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

UFF-A64-PU1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PU(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

AA3-PU1

PT

[Master Module(CCIEF)]
PT(Device)
• Device (decimal): 1 to 90, 1001 to 1090

PT1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

AA3-PT1

PL

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PL(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

A64-PL1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PL(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

UFF-A64-PL1

[Master Module(CCIEF)]
PL(Device)
• Device (decimal): 1 to 72, 1001 to 1072

PL1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PL(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

AA3-PL1

PN

[Master Module(CCIEF)]
PN(Device)
• Device (decimal): 1 to 32, 1001 to 1032

PN1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PN(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

AA3-PN1

PVS [Master/Motion Module(CCIET)]

AA(Axis designation)-PVS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

AA3-PVS1

Device name Device notation and setting range Notation example
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ST

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ST(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

A64-ST0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ST(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

UFF-A64-ST0

[Master Module(CCIEF)]
ST(Device)
• Device (decimal): 0 to 48

ST0

[Master/Motion Module(CCIET)]

AA(Axis designation)-ST(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 48

AA3-ST0

PE

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PE(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 88, 1001 to 1088

A64-PE1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PE(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 88, 1001 to 1088

UFF-A64-PE1

[Master Module(CCIEF)]
PE(Device)
• Device (decimal): 1 to 88, 1001 to 1088

PE1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PE(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 88, 1001 to 1088

AA3-PE1

PF

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PF(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

A64-PF1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PF(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

UFF-A64-PF1

[Master Module(CCIEF)]
PF(Device)
• Device (decimal): 1 to 99, 1001 to 1099

PF1

[Master/Motion Module(CCIET)]

AA(Axis designation)-PF(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

AA3-PF1

NPA [Master/Motion Module(CCIET)]
NPA(Device)
• Device (decimal): 1 to 12, 2001 to 2032

NPA1

ALM

[Motion Controller(SSCNET III/H)]

A(Axis No.)-ALM(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

A64-ALM0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

UFF-A64-ALM0

[Master Module(CCIEF)]
ALM(Device)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315
ALM0

[Master/Motion Module(CCIET)]

AA(Axis designation)-ALM(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

AA3-ALM0

Device name Device notation and setting range Notation example
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POS

[Master Module(CCIEF)]
POS(Device)
• Device (decimal): 1 to 255, 1001 to 1255

POS1

[Master/Motion Module(CCIET)]

AA(Axis designation)-POS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-POS1

SPD

[Master Module(CCIEF)]
SPD(Device)
• Device (decimal): 1 to 255, 1001 to 1255

SPD1

[Master/Motion Module(CCIET)]

AA(Axis designation)-SPD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-SPD1

ACT

[Master Module(CCIEF)]
ACT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

ACT1

[Master/Motion Module(CCIET)]

AA(Axis designation)-ACT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-ACT1

DCT

[Master Module(CCIEF)]
DCT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DCT1

[Master/Motion Module(CCIET)]

AA(Axis designation)-DCT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-DCT1

DWL

[Master Module(CCIEF)]
DWL(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DWL1

[Master/Motion Module(CCIET)]

AA(Axis designation)-DWL(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-DWL1

AUX

[Master Module(CCIEF)]
AUX(Device)
• Device (decimal): 1 to 255, 1001 to 1255

AUX1

[Master/Motion Module(CCIET)]

AA(Axis designation)-AUX(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-AUX1

MCD [Master/Motion Module(CCIET)]

AA(Axis designation)-MCD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-MCD1

MD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-MD(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 21

A64-MD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-MD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 21

UFF-A64-MD0

[Master Module(CCIEF)]
MD(Device)
• Device (decimal): 0 to 21

MD0

[Master/Motion Module(CCIET)]

AA(Axis designation)-MD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 21

AA3-MD0

Device name Device notation and setting range Notation example
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For indirect specification of a module number, axis number, or axis designation, refer to the following.

GFDS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-GFDS(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A64-GFDS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-GFDS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A64-GFDS0

[Master/Motion Module(CCIET)]

AA(Axis designation)-GFDS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-GFDS0

ECCDS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ECCDS(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A64-ECCDS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ECCDS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A64-ECCDS0

[Master/Motion Module(CCIET)]

AA(Axis designation)-ECCDS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-ECCDS0

OTS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OTS(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5, 3000

A64-OTS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5, 3000

UFF-A64-OTS0

[Master Module(CCIEF)]
OTS(Device)
• Device (decimal): 0 to 5, 3000

OTS0

[Master/Motion Module(CCIET)]

AA(Axis designation)-OTS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5, 3000

AA3-OTS0

DI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-DI(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

A64-DI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A64-DI0

[Master Module(CCIEF)]
DI(Device)
• Device (decimal): 0 to 6

DI0

[Master/Motion Module(CCIET)]

AA(Axis designation)-DI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

AA3-DI0

DO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-DO(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

A64-DO0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

UFF-A64-DO0

[Master Module(CCIEF)]
DO(Device)
• Device (decimal): 0 to 4

DO0

[Master/Motion Module(CCIET)]

AA(Axis designation)-DO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 4

AA3-DO0

Device name Device notation and setting range Notation example
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➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W R/W R/W

SD R/W R/W R/W R/W

W R/W R/W R/W R/W

SW R/W R/W -/- R/W

R R/W R/W R/W R/W

ER R/W R/W R/W R/W

ZR R/W R/W R/W R/W

Z R/W R/W -/- -/-

G R/W R/W R/W R/W

Ww R/W R/W R/W R/W

Wr R/W R/W R/W R/W

LW R/W R/W R/W R/W

# R/W R/W -/- R/W

U3E0 R/W R/W R/W R/W

U3E1 R/W R/W R/W R/W

U3E2 R/W R/W R/W R/W

U3E3 R/W R/W R/W R/W

SATN R/- R/- -/- -/-

SACN R/- R/- -/- -/-

SASN R/- R/- -/- -/-

SAD R/- R/- -/- R/-

SASD R/- R/- -/- R/-

SAW R/- R/- -/- R/-

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PO R/W R/W -/- -/-

PS R/W R/W -/- -/-

PU R/W R/W -/- -/-

PT R/W R/W -/- -/-

PL R/W R/W -/- -/-

PN R/W R/W -/- -/-
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*1 Only reading is available for NPA1 and NPA2001 to NPA2032.
*2 Only reading is available for OTS0 to OTS5.

PVS R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

NPA*1 R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MCD R/W R/W -/- -/-

MD R/- R/- -/- -/-

GFDS R/- R/- -/- -/-

ECCDS R/- R/- -/- -/-

OTS*2 R/W R/W -/- -/-

DI R/- R/W -/- -/-

DO R/- R/- -/- -/-

JnW R/W R/W R/W R/W

JnSW R/W R/W -/- R/W

U3E0G R/W R/W R/W R/W

U3E1G R/W R/W R/W R/W

U3E2G R/W R/W R/W R/W

U3E3G R/W R/W R/W R/W

RD R/W R/W R/W R/W

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data
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■7 Monitoring-supported double-word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.2 ■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.2 ■10 Virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-

D])
*3 Virtual inverter device

For the details, refer to the following.
➟12.3.2 ■12 Virtual inverter devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

*4 For the maximum number of devices when an extended SRAM cassette is installed, refer to the following.

➟MELSEC iQ-R CPU Module User's Manual (Application)
*5 If you specify LPr900 to LPr935, the following item is displayed in the device setting dialog.

• [Setting items (for calibration parameters)]: [Bias/gain value], [Analog input value]
Enclose the device number in parentheses when selecting [Analog input value].
Example 1) Notation when [Bias/gain value] is selected: LPr900
Example 2) Notation when [Analog input value] is selected: LPr(900)
When LPr900 or LPr901 (Calibration parameter) is specified, selecting [Bias/gain value] or [Analog input value] does not 
affect the monitoring target.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LTN*4 Long timer current value Decimal 0 to 2529407 × ×

LCN*4 Long counter current value Decimal 0 to 4761215 × ×

LSN*4 Long retentive timer current value Decimal 0 to 2529407 × ×

ZZ Index register (32 bits) Decimal 0 to 22 × ×

LZ Index register (32 bits) Decimal 0 to 11 × ×

ALD*2 Life diagnosis Decimal

➟12.3.2 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

× ×

TMI*2
Input signal for test operation (for 
test operation) Decimal

➟12.3.2 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

× ×

TMO*2 Forced output of signal pin (for test 
operation) Decimal

➟12.3.2 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

× ×

TMD*2 Set data (for test operation) Decimal
➟12.3.2 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC 
iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

× ×

AL*3 Faults history Decimal 0 to 899 × ×

LPr*3*5 Parameter (32-bit) Decimal 0 to 1500 × ×

OP*3 Operation parameter Decimal 0 to 5 × ×

PV*3 Current value monitor Decimal 1 to 143 × ×
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■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (RD77MS).
The following items are displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (RD77GF).

[Master/Motion Module(CCIET)]

Select this item to connect the GOT through the master station on the CC-Link IE TSN 
and a Motion module (RD78G(H)).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.

Device name Device notation and setting range Notation example

ALD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ALD(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A64-ALD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A64-ALD0

[Master Module(CCIEF)]
ALD(Device)
• Device (decimal): 0 to 1

ALD0

[Master/Motion Module(CCIET)]

AA(Axis designation)-ALD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-ALD0
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For indirect specification of a module number, axis number, or axis designation, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-R, RnMT/NC/
RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

TMI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMI(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

A64-TMI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

UFF-A64-TMI0

[Master Module(CCIEF)]
TMI(Device)
• Device (decimal): 0 to 2

TMI0

[Master/Motion Module(CCIET)]

AA(Axis designation)-TMI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2

AA3-TMI0

TMO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMO(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0

A64-TMO0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0

UFF-A64-TMO0

[Master Module(CCIEF)]
TMO(Device)
• Device (decimal): 0

TMO0

[Master/Motion Module(CCIET)]

AA(Axis designation)-TMO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0

AA3-TMO0

TMD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMD(Device)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

A64-TMD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

UFF-A64-TMD0

[Master Module(CCIEF)]
TMD(Device)
• Device (decimal): 0 to 1, 3

TMD0

[Master/Motion Module(CCIET)]

AA(Axis designation)-TMD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1, 3

AA3-TMD0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LTN -/- R/W -/- -/-

LCN -/- R/W -/- -/-

LSN -/- R/W -/- -/-

ZZ -/- R/W -/- -/-
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■10 Virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

LZ -/- R/W -/- -/-

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

AL -/- R/- -/- -/-

LPr -/- R/W -/- -/-

OP -/- R/W -/- -/-

PV -/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OM ➟(2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMB ➟(3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

OTI ➟(4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

GFDI ➟(5) Gear failure diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ECCDI ➟(6) Encoder communication circuit diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

PA ➟(7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PB ➟(8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PC ➟(9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PD ➟(10) I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PO ➟(11) Option unit parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PS ➟(12) Special parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PU ➟(13) Multi encoder parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PT ➟(14) Positioning control parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PL ➟(15) Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PN ➟(16) Network setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PVS ➟(17) Position extension parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ST ➟(18) Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PE ➟(19) Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

PF ➟(20) Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

NPA ➟(21) Network basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ALM

➟(22) Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

➟(23) Specifications of ALM260 to ALM275, ALM280 to ALM295, and ALM300 to ALM315 ([MELSEC iQ-R, RnMT/NC/
RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

POS ➟(24) Point table (position) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
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SPD ➟(25) Point table (speed) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ACT ➟(26) Point table (acceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

DCT ➟(27) Point table (deceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

DWL ➟(28) Point table (dwell) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AUX ➟(29) Point table (auxiliary function) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

MCD ➟(30) Point table (M code) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

MD ➟(31) Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

GFDS ➟(32) Gear failure diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ECCDS ➟(33) Encoder communication circuit diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

OTS ➟(34) One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

DI

➟(35) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

(36) External input signal in MR-J5D□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
(37) External input signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])
(38) External input signal in MR-JET-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
(39) External input signal in MR-JE-B and MR-JE-BF ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/

RT, CR800-D])
(40) External input signal in MR-J4-GF(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-

D])
(41) External input signal in MR-J4(W)-□B-RJ ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])

DO

➟(42) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

(43) External output signal in MR-J5D□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

(44) External output signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

(45) External output signal in MR-JET-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
(46) External output signal in MR-JE-B and MR-JE-BF ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/

RT, CR800-D])
(47) External output signal in MR-J4-GF(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])
(48) External output signal in MR-J4(W)-□B-RJ ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])

ALD ➟(49) Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMI ➟(50) Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

TMO ➟(51) Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

TMD ➟(52) Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device name Reference
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(1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])
○: Available
×: Not available

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])
○: Available
×: Not available

When using the operation mode selection, note the following.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

SP0 Status display data clear - ○ ○ ○ ○ ○ ○ ○ ○

SP1 Current alarm clear - ○ ○ ○ ○ ○ ○ ○ ○

SP2 Alarm history clear - ○ ○ ○ ○ ○ ○ ○ ○

SP3 External input signal 
prohibited - ○ ○ ○ ○ ○ ○ ○ ○

SP4 External output signal 
prohibited - ○ ○ ○ ○ ○ ○ ○ ○

SP5 External input signal 
resumed - ○ ○ ○ ○ ○ ○ ○ ○

SP6 External output signal 
resumed - ○ ○ ○ ○ ○ ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

OM0

Normal mode (not test 
operation mode) -

○ ○ ○ ○ × × × ×

Cancel test operation mode × × × × ○ ○ ○ ○

OM1 JOG operation - ○ ○ ○ ○ ○ ○ ○ ○

OM2 Positioning operation - ○ ○ ○ ○ ○ ○ ○ ○

OM3 For manufacturer setting - × × × × × × × ×

OM4 Output signal (DO) forced 
output - ○ ○ ○ ○ ○ ○ ○ ○

OM5 Single-step feed operation - × ○ × × ○ ○ ○ ○

OM6 For manufacturer setting - × × × × × × × ×

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])
○: Available
×: Not available

When using the instruction demand (for test operation), note the following.

(4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
○: Available
×: Not available

When using the one-touch tuning instruction, note the following.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

TMB1
Temporary stop command

-
○ ○ ○ ○ × × × ×

Pause × × × × ○ ○ ○ ○

TMB2 Test operation (positioning 
operation) start command - ○ ○ ○ ○ ○ ○ ○ ○

TMB3 Forward rotation direction - ○ ○ ○ ○ ○ ○ ○ ○

TMB4 Reverse rotation direction - ○ ○ ○ ○ ○ ○ ○ ○

TMB5 Restart for remaining 
distance - ○ ○ ○ ○ ○ ○ ○ ○

TMB6 Remaining distance clear - ○ ○ ○ ○ ○ ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

OTI0 One-touch tuning start 
command (Basic mode) - ○ ○ ○ ○ ○ ○ ○ ○

OTI1 One-touch tuning start 
command (High mode) - ○ ○ ○ ○ ○ ○ ○ ○

OTI2 One-touch tuning start 
command (Low mode) - ○ ○ ○ ○ ○ ○ ○ ○

OTI3 One-touch tuning stop 
command - ○ ○ ○ ○ ○ ○ ○ ○

OTI4 Return to initial value - ○ ○ ○ ○ ○ ○ ○ ○

OTI5 Return to value before 
adjustment - ○ ○ ○ ○ ○ ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(5) Gear failure diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
○: Available
×: Not available

When using the gear failure diagnosis instruction, note the following.

(6) Encoder communication circuit diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

When using the encoder communication circuit diagnosis instruction, note the following.

(7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA44: Writing data to the RAM of a servo amplifier
• PA1001 to PA1044: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

GFDI0 Backlash estimation start 
command - × × × × ○ × ○ ○

GFDI1 Backlash estimation stop 
command - × × × × ○ × ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ECCDI0
CN2 encoder 
communication circuit 
diagnosis start command

- × × × × ○ ○ ○ ○

ECCDI1
CN2L encoder 
communication circuit 
diagnosis start command

- × × × × ○ ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PA1, 
PA1001 Operation mode **STY ○ ○ × × ○ × ○ ○

PA2, 
PA1002 Regenerative brake option **REG ○ ○ ○ ○ ○ ○ ○ ○

PA3, 
PA1003

Absolute position detection 
system *ABS ○ ○ ○ ○ ○ ○ ○ ○

PA4, 
PA1004 Function selection A-1 *AOP1 ○ ○ ○ ○ ○ ○ ○ ○

PA5, 
PA1005 For manufacturer setting - × × × × × × × ×

PA6, 
PA1006 Electronic gear numerator *CMX × ○ × × ○ ○ ○ ○
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PA7, 
PA1007 Electronic gear denominator *CDV × ○ × × ○ ○ ○ ○

PA8, 
PA1008 Auto tuning mode ATU ○ ○ ○ ○ ○ ○ ○ ○

PA9, 
PA1009 Auto tuning response RSP ○ ○ ○ ○ ○ ○ ○ ○

PA10, 
PA1010 In-position range INP ○ ○ ○ ○ ○ ○ ○ ○

PA11, 
PA1011

Forward rotation torque limit/
positive direction thrust limit TLP

× ○ × × × × × ×

Forward rotation torque limit × × × × ○ ○ ○ ○

PA12, 
PA1012

Reverse rotation torque limit/
negative direction thrust limit TLN

× ○ × × × × × ×

Reverse rotation torque limit × × × × ○ ○ ○ ○

PA13, 
PA1013 For manufacturer setting - × × × × × × × ×

PA14, 
PA1014

Rotation direction selection/
travel direction selection *POL

○ ○ ○ ○ × × × ×

Moving direction selection × × × × ○ ○ ○ ○

PA15, 
PA1015 Encoder output pulse *ENR ○ ○ × × ○ × ○ ○

PA16, 
PA1016 Encoder output pulse 2 *ENR2 ○ ○ × × ○ × ○ ○

PA17, 
PA1017 Servo motor series setting **MSR ○ ○ × × ○ × ○ ○

PA18, 
PA1018 Servo motor type setting **MTY ○ ○ × × ○ × ○ ○

PA19, 
PA1019 Parameter block *BLK ○ ○ ○ ○ ○ ○ ○ ○

PA20, 
PA1020 Tough drive setting *TDS ○ ○ ○ ○ ○ ○ ○ ○

PA21, 
PA1021 Function selection A-3 *AOP3 ○ ○ ○ ○ ○ ○ ○ ○

PA22, 
PA1022

Position control composition 
selection **PCS ○ ○ × × ○ ○ ○ ○

PA23, 
PA1023

Drive recorder arbitrary 
alarm trigger setting DRAT ○ ○ ○ ○ ○ ○ ○ ○

PA24, 
PA1024 Function selection A-4 AOP4 ○ ○ ○ ○ ○ ○ ○ ○

PA25, 
PA1025

One-touch tuning - 
Overshoot permissible level OTHOV ○ ○ ○ ○ ○ ○ ○ ○

PA26, 
PA1026 Function selection A-5 *AOP5 ○ ○ ○ ○ ○ ○ ○ ○

PA27, 
PA1027 Hot-line forced stop function *HTL × × ○ ○ × × × ×

PA28, 
PA1028 Function selection A-6 **AOP6 × × × × ○ ○ ○ ○

PA29 to 
PA33, 
PA1029 
to 
PA1033

For manufacturer setting - × × × × × × × ×

PA34, 
PA1034

Quick tuning permissible 
travel distance QDIS × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB92: Writing data to the RAM of a servo amplifier
• PB1001 to PB1092: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PA35 to 
PA44, 
PA1035 
to 
PA1044

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PB1, 
PB1001

Adaptive tuning mode 
(Adaptive filter II) FILT ○ ○ ○ ○ ○ ○ ○ ○

PB2, 
PB1002

Vib. supp. ctrl tuning mode 
(Adv. vib. supp. ctrl II) VRFT ○ ○ ○ ○ ○ ○ ○ ○

PB3, 
PB1003 Torque feedback loop gain TFBG

N ○ × ○ ○ × × ○ ×

PB4, 
PB1004 Feed forward gain FFC ○ ○ ○ ○ ○ ○ ○ ○

PB5, 
PB1005 For manufacturer setting - × × × × × × × ×

PB6, 
PB1006

Load inertia moment ratio/
Load mass ratio GD2 ○ ○ ○ ○ ○ ○ ○ ○

PB7, 
PB1007 Model loop gain PG1 ○ ○ ○ ○ ○ ○ ○ ○

PB8, 
PB1008 Position loop gain PG2 ○ ○ ○ ○ ○ ○ ○ ○

PB9, 
PB1009 Speed loop gain VG2 ○ ○ ○ ○ ○ ○ ○ ○

PB10, 
PB1010

Speed integral 
compensation VIC ○ ○ ○ ○ ○ ○ ○ ○

PB11, 
PB1011

Speed differential 
compensation VDC ○ ○ ○ ○ ○ ○ ○ ○

PB12, 
PB1012

Overshoot amount 
compensation OVA ○ ○ ○ ○ ○ ○ ○ ○

PB13, 
PB1013

Machine resonance 
suppression filter 1 NH1 ○ ○ ○ ○ ○ ○ ○ ○

PB14, 
PB1014 Notch shape selection 1 NHQ1 ○ ○ ○ ○ ○ ○ ○ ○

PB15, 
PB1015

Machine resonance 
suppression filter 2 NH2 ○ ○ ○ ○ ○ ○ ○ ○

PB16, 
PB1016 Notch shape selection 2 NHQ2 ○ ○ ○ ○ ○ ○ ○ ○

PB17, 
PB1017

Shaft resonance 
suppression filter NHF ○ ○ ○ ○ ○ ○ ○ ○

PB18, 
PB1018 Low-pass filter setting LPF ○ ○ ○ ○ ○ ○ ○ ○

PB19, 
PB1019

Vibration suppression 
control 1 - Vibration 
frequency

VRF11 ○ ○ ○ ○ ○ ○ ○ ○

PB20, 
PB1020

Vibration suppression 
control 1 - Resonance freq. VRF12 ○ ○ ○ ○ ○ ○ ○ ○
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PB21, 
PB1021

Vib. supp. ctrl. 1 - Vibration 
frequency damping VRF13 ○ ○ ○ ○ ○ ○ ○ ○

PB22, 
PB1022

Vib. supp. ctrl. 1 - 
Resonance frequency 
damping

VRF14 ○ ○ ○ ○ ○ ○ ○ ○

PB23, 
PB1023 Low-pass filter selection VFBF ○ ○ ○ ○ ○ ○ ○ ○

PB24, 
PB1024

Slight vibration suppression 
control *MVS ○ ○ ○ ○ ○ ○ ○ ○

PB25, 
PB1025 Function selection B-1 *BOP1 ○ ○ ○ ○ ○ ○ ○ ○

PB26, 
PB1026 Gain changing function *CDP ○ ○ ○ ○ ○ ○ ○ ○

PB27, 
PB1027 Gain changing condition CDL ○ ○ ○ ○ ○ ○ ○ ○

PB28, 
PB1028 Gain changing time constant CDT ○ ○ ○ ○ ○ ○ ○ ○

PB29, 
PB1029

Gain changing - Load in. 
mom. rat./Load mass rat. GD2B ○ ○ ○ ○ ○ ○ ○ ○

PB30, 
PB1030

Gain changing position loop 
gain PG2B ○ ○ ○ ○ ○ ○ ○ ○

PB31, 
PB1031

Gain changing speed loop 
gain VG2B ○ ○ ○ ○ ○ ○ ○ ○

PB32, 
PB1032

Gain changing speed 
integral compensation VICB ○ ○ ○ ○ ○ ○ ○ ○

PB33, 
PB1033

Vib. supp. ctrl. 1 - Vib. frq. 
after gain changing

VRF11
B ○ ○ ○ ○ ○ ○ ○ ○

PB34, 
PB1034

Vib. supp. ctrl. 1 - Res. frq. 
after gain changing

VRF12
B ○ ○ ○ ○ ○ ○ ○ ○

PB35, 
PB1035

Vib. supp. ctrl. 1 - Vib. frq. 
damping after gain chng

VRF13
B ○ ○ ○ ○ ○ ○ ○ ○

PB36, 
PB1036

Vib. supp. ctrl. 1 - Res. frq. 
damping after gain chng

VRF14
B ○ ○ ○ ○ ○ ○ ○ ○

PB37 to 
PB44, 
PB1037 to 
PB1044

For manufacturer setting - × × × × × × × ×

PB45, 
PB1045 Command notch filter CNHF ○ ○ ○ ○ ○ ○ ○ ○

PB46, 
PB1046

Machine resonance 
suppression filter 3 NH3 ○ ○ ○ ○ ○ ○ ○ ○

PB47, 
PB1047 Notch shape selection 3 NHQ3 ○ ○ ○ ○ ○ ○ ○ ○

PB48, 
PB1048

Machine resonance 
suppression filter 4 NH4 ○ ○ ○ ○ ○ ○ ○ ○

PB49, 
PB1049 Notch shape selection 4 NHQ4 ○ ○ ○ ○ ○ ○ ○ ○

PB50, 
PB1050

Machine resonance 
suppression filter 5 NH5 ○ ○ ○ ○ ○ ○ ○ ○

PB51, 
PB1051 Notch shape selection 5 NHQ5 ○ ○ ○ ○ ○ ○ ○ ○

PB52, 
PB1052

Vibration suppression 
control 2 - Vibration 
frequency

VRF21 ○ ○ ○ ○ ○ ○ ○ ○

PB53, 
PB1053

Vibration suppression 
control 2 - Resonance freq. VRF22 ○ ○ ○ ○ ○ ○ ○ ○

PB54, 
PB1054

Vib. supp. ctrl. 2 - Vibration 
frequency damping VRF23 ○ ○ ○ ○ ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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PB55, 
PB1055

Vib. supp. ctrl. 2 - 
Resonance frequency 
damping

VRF24 ○ ○ ○ ○ ○ ○ ○ ○

PB56, 
PB1056

Vib. supp. ctrl. 2 - Vib. frq. 
after gain changing

VRF21
B ○ ○ ○ ○ ○ ○ ○ ○

PB57, 
PB1057

Vib. supp. ctrl. 2 - Res. frq. 
after gain changing

VRF22
B ○ ○ ○ ○ ○ ○ ○ ○

PB58, 
PB1058

Vib. supp. ctrl. 2 - Vib. frq. 
damping after gain chng

VRF23
B ○ ○ ○ ○ ○ ○ ○ ○

PB59, 
PB1059

Vib. supp. ctrl. 2 - Res. frq. 
damping after gain chng

VRF24
B ○ ○ ○ ○ ○ ○ ○ ○

PB60, 
PB1060

Gain changing model loop 
gain PG1B ○ ○ ○ ○ ○ ○ ○ ○

PB61 to 
PB64, 
PB1061 to 
PB1064

For manufacturer setting - × × × × × × × ×

PB65, 
PB1065 Gain changing 2 condition CDL2 × × × × ○ ○ ○ ○

PB66, 
PB1066

Gain changing 2 time 
constant CDT2 × × × × ○ ○ ○ ○

PB67, 
PB1067

Gain changing 2 - Load in. 
mom. rat./Load mass rat. GD2C × × × × ○ ○ ○ ○

PB68, 
PB1068

Gain changing 2 position 
loop gain PG2C × × × × ○ ○ ○ ○

PB69, 
PB1069

Gain changing 2 speed loop 
gain VG2C × × × × ○ ○ ○ ○

PB70, 
PB1070

Gain changing 2 speed 
integral compensation VICC × × × × ○ ○ ○ ○

PB71, 
PB1071

Vib. supp. ctrl. 1 - Vib. frq. 
after gain changing 2

VRF11
C × × × × ○ ○ ○ ○

PB72, 
PB1072

Vib. supp. ctrl. 1 - Res. frq. 
after gain changing 2

VRF12
C × × × × ○ ○ ○ ○

PB73, 
PB1073

Vib. supp. ctrl. 1 - Vib. frq. 
damping aft. gain chng2

VRF13
C × × × × ○ ○ ○ ○

PB74, 
PB1074

Vib. supp. ctrl. 1 - Res. frq. 
damping aft. gain chng2

VRF14
C × × × × ○ ○ ○ ○

PB75, 
PB1075

Vib. supp. ctrl. 2 - Vib. frq. 
after gain changing 2

VRF21
C × × × × ○ ○ ○ ○

PB76, 
PB1076

Vib. supp. ctrl. 2 - Res. frq. 
after gain changing 2

VRF22
C × × × × ○ ○ ○ ○

PB77, 
PB1077

Vib. supp. ctrl. 2 - Vib. frq. 
damping aft. gain chng2

VRF23
C × × × × ○ ○ ○ ○

PB78, 
PB1078

Vib. supp. ctrl. 2 - Res. frq. 
damping aft. gain chng2

VRF24
C × × × × ○ ○ ○ ○

PB79, 
PB1079

Gain changing 2 model loop 
gain PG1C × × × × ○ ○ ○ ○

PB80, 
PB1080 For manufacturer setting - × × × × × × × ×

PB81, 
PB1081 Command filter *CFIL × × × × ○ ○ ○ ○

PB82, 
PB1082

Position command 
smoothing filter time 
constant

PFT × × × × ○ ○ ○ ○

PB83 to 
PB92, 
PB1083 to 
PB1092

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC90: Writing data to the RAM of a servo amplifier
• PC1001 to PC1090: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PC1, 
PC1001 Error excessive alarm level ERZ ○ ○ ○ ○ ○ ○ ○ ○

PC2, 
PC1002

Electromagnetic brake 
sequence output MBR ○ ○ ○ ○ ○ ○ ○ ○

PC3, 
PC1003

Encoder output pulse 
selection *ENRS ○ ○ × × ○ × ○ ○

PC4, 
PC1004 Function selection C-1 **COP1 ○ ○ ○ ○ ○ ○ ○ ○

PC5, 
PC1005 Function selection C-2 **COP2 ○ ○ ○ ○ ○ ○ ○ ○

PC6, 
PC1006 Function selection C-3 *COP3 ○ ○ ○ ○ ○ ○ ○ ○

PC7, 
PC1007 Zero speed ZSP ○ ○ ○ ○ ○ ○ ○ ○

PC8, 
PC1008

Overspeed alarm detection 
level OSL ○ ○ ○ ○ ○ ○ ○ ○

PC9, 
PC1009 Analog monitor 1 output MOD1 ○ ○ × × ○ × ○ ○

PC10, 
PC1010 Analog monitor 2 output MOD2 ○ ○ × × ○ × ○ ○

PC11, 
PC1011 Analog monitor 1 offset MO1 ○ ○ × × ○ × ○ ○

PC12, 
PC1012 Analog monitor 2 offset MO2 ○ ○ × × ○ × ○ ○

PC13, 
PC1013

Analog monitor - Feedback 
position output standard 
data - Low

MOSDL ○ × × × × × × ×

PC14, 
PC1014

Analog monitor - Feedback 
position output standard 
data - High

MOSDH ○ × × × × × × ×

PC15, 
PC1015 For manufacturer setting - × × × × × × × ×

PC16, 
PC1016 Function selection C-3A *COP3A × × × × ○ × ○ ○

PC17, 
PC1017 Function selection C-4 **COP4 ○ ○ ○ ○ ○ × ○ ○

PC18, 
PC1018 Function selection C-5 *COP5 ○ ○ ○ ○ × × × ×

PC19, 
PC1019 Function selection C-6 *COP6 × ○ × × ○ ○ ○ ○

PC20, 
PC1020 Function selection C-7 *COP7 ○ ○ ○ ○ ○ ○ ○ ○

PC21, 
PC1021 Alarm history clear *BPS ○ ○ ○ ○ ○ ○ ○ ○

PC22 and 
PC23, 
PC1022 
and 
PC1023

For manufacturer setting - × × × × × × × ×
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PC24, 
PC1024

Forced stop deceleration 
time constant RSBR ○ ○ ○ ○ ○ ○ ○ ○

PC25, 
PC1025 For manufacturer setting - × × × × × × × ×

PC26, 
PC1026 Function selection C-8 **COP8 ○ ○ × × ○ × ○ ○

PC27, 
PC1027 Function selection C-9 **COP9 ○ ○ × × ○ ○ ○ ○

PC28, 
PC1028 For manufacturer setting - × × × × × × × ×

PC29, 
PC1029 Function selection C-B *COPB ○ ○ ○ ○ ○ ○ ○ ○

PC30, 
PC1030 For manufacturer setting - × × × × × × × ×

PC31, 
PC1031

Vertical ax.freefall 
prevention compensation 
amount

RSUP1 ○ ○ ○ ○ ○ ○ ○ ○

PC32 to 
PC36, 
PC1032 to 
PC1036

For manufacturer setting - × × × × × × × ×

PC37, 
PC1037 Function selection C-D **COPD × × × × × × × ○

PC38, 
PC1038

Error excessive warning 
level ERW ○ ○ ○ ○ ○ ○ ○ ○

PC39, 
PC1039 Collision detection level 1 TLW1 × × × × × × × ○

PC40, 
PC1040 Collision detection level 2 TLW2 × × × × × × × ○

PC41, 
PC1041 Function selection C-J *COPJ × × × × × × ○ ○

PC42 to 
PC44, 
PC1042 to 
PC1044

For manufacturer setting - × × × × × × × ×

PC45, 
PC1045

Drive unit function 
selection 1

*DUOP1 × × × × × × × ○

PC46, 
PC1046

Drive unit function 
selection 2

*DUOP2 × × × × × × ○ ○

PC47 to 
PC64, 
PC1047 to 
PC1064

For manufacturer setting - × × × × × × × ×

PC65, 
PC1065 Zero speed 2 level ZSP2L × × × × ○ × ○ ○

PC66, 
PC1066 Zero speed 2 filter time ZSP2F × × × × ○ × ○ ○

PC67, 
PC1067 Following error output level

FEWL × ○ × × × × × ×

FEW × × × × ○ ○ ○ ○

PC68, 
PC1068 Following error output level FEWH × ○ × × × × × ×

PC69, 
PC1069

Following error output filter 
time FEWF × ○ × × ○ ○ ○ ○

PC70, 
PC1070 In-position 2 output range INP2R × × × × ○ × ○ ○

PC71, 
PC1071

In-position 2 output filter 
time INP2F × × × × ○ × ○ ○

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(10)I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD72: Writing data to the RAM of a servo amplifier
• PD1001 to PD1072: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PC72, 
PC1072

Speed reached 2 output 
range SA2R × × × × ○ × ○ ○

PC73, 
PC1073

Speed reached 2 output 
filter time SA2F × × × × ○ × ○ ○

PC74 to 
PC75, 
PC1074 to 
PC1075

For manufacturer setting - × × × × × × × ×

PC76, 
PC1076 Function selection C-E *COPE × ○ × × ○ ○ ○ ○

PC77, 
PC1077 Internal torque limit 2 TL2 × ○ × × × × × ○

PC78, 
PC1078 Function selection C-F *COPF × × × × ○ ○ ○ ○

PC79, 
PC1079 Function selection C-G *COPG × × × × ○ ○ ○ ○

PC80, 
PC1080 For manufacturer setting - × × × × × × × ×

PC81, 
PC1081 Function selection C-H **COPH × × × × ○ × × ○

PC82 to 
PC90, 
PC1082 to 
PC1090

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbol
MR-

J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PD1, 
PD1001

Input signal automatic on 
selection 1 *DIA1 × ○ × × ○ ○ ○ ○

PD2, 
PD1002

Input signal automatic on 
selection 2 *DIA2 ○ × × ○ × × × ○

PD3, 
PD1003 Input device selection 1 *DI1 × ○ × ○ ○ ○ ○ ○

PD4, 
PD1004 Input device selection 2 *DI2 × ○ × ○ ○ ○ ○ ○

PD5, 
PD1005 Input device selection 3 *DI3 × ○ × ○ ○ ○ ○ ○

PD6, 
PD1006 For manufacturer setting - × × × × × × × ×

PD7, 
PD1007 Output device selection 1 *DO1 ○ ○ ○ ○ ○ ○ ○ ○

PD8, 
PD1008 Output device selection 2 *DO2 ○ ○ × ○ ○ ○ ○ ○

PD9, 
PD1009 Output device selection 3 *DO3 ○ ○ × ○ ○ ○ ○ ○

PD10, 
PD1010 For manufacturer setting - × × × × × × × ×

PD11, 
PD1011 Input filter setting *DIF ○ ○ ○ ○ ○ ○ ○ ○
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PD12, 
PD1012 Function selection D-1 *DOP1 ○ ○ ○ ○ ○ ○ ○ ○

PD13, 
PD1013 Function selection D-2 *DOP2 ○ ○ ○ ○ ○ ○ ○ ○

PD14, 
PD1014 Function selection D-3 *DOP3 ○ ○ ○ ○ ○ ○ ○ ○

PD15, 
PD1015

Driver communication 
setting *IDCS ○ × × × × × × ○

PD16, 
PD1016

Driver communication 
setting - Master - Transmit 
data selection 1

*MD1 ○ × × × × × × ○

PD17, 
PD1017

Driver communication 
setting - Master - Transmit 
data selection 2

*MD2 ○ × × × × × × ○

PD18 and 
PD19, 
PD1018 
and 
PD1019

For manufacturer setting - × × × × × × × ×

PD20, 
PD1020

Driver communication 
setting - Slave - Master axis 
No. selection 1

*SLA1 ○ × × × × × × ○

PD21 to 
PD29, 
PD1021 to 
PD1029

For manufacturer setting - × × × × × × × ×

PD30, 
PD1030

Master-slave operation - 
Torque command coefficient 
on slave

TLC ○ × × × × × × ○

PD31, 
PD1031

Master-slave operation - 
Speed limit coefficient on 
slave

VLC ○ × × × × × × ○

PD32, 
PD1032

Master-slave operation - 
Speed limit adjusted value 
on slave

VLL ○ × × × × × × ○

PD33 to 
PD36, 
PD1033 to 
PD1036

For manufacturer setting - × × × × × × × ×

PD37, 
PD1037

Touch probe function 
selection *TPOP × ○ × × × × × ×

PD38, 
PD1038 Input device selection 4 *DI4 × × × × ○ × ○ ○

PD39, 
PD1039 Input device selection 5 *DI5 × × × × ○ × ○ ○

PD40, 
PD1040 For manufacturer setting - × × × × × × × ○

PD41, 
PD1041 Function selection D-4 *DOP4 × ○ × × ○ ○ ○ ○

PD42 to 
PD50, 
PD1042 to 
PD1050

For manufacturer setting - × × × × × × × ×

PD51, 
PD1051 Input device selection 3-2 *DI3W

2 × × × × ○ × ○ ○

PD52 to 
PD59, 
PD1052 to 
PD1059

For manufacturer setting - × × × × × × × ×

PD60, 
PD1060 DI pin polarity selection *DIP × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(11)Option unit parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PO1 to PO2: Writing data to the RAM of a servo amplifier
• PO1001 to PO1002: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(12)Special parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PS1 to PS99: Writing data to the RAM of a servo amplifier
• PS1001 to PS1099: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(13)Multi encoder parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])
Use an appropriate device according to the write destination of the servo amplifier.

• PU1 to PU44: Writing data to the RAM of a servo amplifier
• PU1001 to PU1044: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

PD61 to 
PD72, 
PD1061 to 
PD1072

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PO1 to 
PO2, 
PO1001 to 
PO1002

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PS1 to 
PS99, 
PS1001 to 
PS1099

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PU1 to 
PU44, 
PU1001 to 
PU1044

For manufacturer setting - × × × × × × × ×
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(14)Positioning control parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PT1 to PT90: Writing data to the RAM of a servo amplifier
• PT1001 to PT1090: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PT1, 
PT1001 Command mode selection **CTY × ○ × × ○ ○ ○ ×

PT2, 
PT1002 Function selection T-1 *TOP1 × × × × ○ × ○ ×

PT3, 
PT1003 Feeding function selection *FTY × ○ × × × × × ×

PT4, 
PT1004 For manufacturer setting - × × × × × × × ×

PT5, 
PT1005 Home position return speed ZRF × ○ × × ○ ○ ○ ×

PT6, 
PT1006 Creep speed CRF × ○ × × ○ ○ ○ ×

PT7, 
PT1007 Home position shift distance ZST × ○ × × ○ ○ ○ ×

PT8, 
PT1008

Home position return 
position data ZPS × × × × ○ ○ ○ ×

PT9, 
PT1009

Moving distance after 
proximity dog DCT × ○ × × ○ ○ ○ ×

PT10, 
PT1010

Stopper type home position 
return stopper time ZTM × ○ × × ○ ○ ○ ×

PT11, 
PT1011

Stopper type home position 
return torque limit value ZTT × ○ × × ○ ○ ○ ×

PT12, 
PT1012 Rough match output range CRP × ○ × × ○ × ○ ×

PT13 to 
PT14, 
PT1013 to 
PT1014

For manufacturer setting - × × × × × × × ×

PT15, 
PT1015

Software limit + LMPL × ○ × × × × × ×

Software position limit+ LMP × × × × ○ ○ ○ ×

PT16, 
PT1016 Software limit + LMPH × ○ × × × × × ×

PT17, 
PT1017

Software limit - LMNL × ○ × × × × × ×

Software position limit- LMN × × × × ○ ○ ○ ×

PT18, 
PT1018 Software limit - LMNH × ○ × × × × × ×

PT19, 
PT1019

Position range output 
address + *LPPL × ○ × × × × × ×

Position range output 1 
address+ *LPP1 × × × × ○ × ○ ×

PT20, 
PT1020

Position range output 
address + *LPPH × ○ × × × × × ×

PT21, 
PT1021

Position range output 
address - *LNPL × ○ × × × × × ×

Position range output 1 
address- *LNP1 × × × × ○ × ○ ×
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PT22, 
PT1022

Position range output 
address - *LNPH × ○ × × × × × ×

PT23 to 
PT28, 
PT1023 to 
PT1028

For manufacturer setting - × × × × × × × ×

PT29, 
PT1029 Function selection T-3 *TOP3 × ○ × × ○ ○ ○ ×

PT30 to 
PT33, 
PT1030 to 
PT1033

For manufacturer setting - × × × × × × × ×

PT34, 
PT1034

Point table default *PDEF × ○ × × × × × ×

Positioning operation data 
default *PDEF × × × × × × ○ ×

PT35 to 
PT37, 
PT1035 to 
PT1037

For manufacturer setting - × × × × × × × ×

PT38, 
PT1038 Function selection T-7 *TOP7 × × × × × × ○ ×

PT39 to 
PT40, 
PT1039 to 
PT1040

For manufacturer setting - × × × × × × × ×

PT41, 
PT1041

Home position return inhibit 
selection ORP × ○ × × × × × ×

Function selection T-8 TOP8 × × × × ○ ○ ○ ×

PT42 to 
PT44, 
PT1042 to 
PT1044

For manufacturer setting - × × × × × × × ×

PT45, 
PT1045 Home position return method HMM × ○ × × ○ ○ ○ ×

PT46 to 
PT48, 
PT1046 to 
PT1048

For manufacturer setting - × × × × × × × ×

PT49, 
PT1049 Acceleration time constant STA × ○ × × ○ × ○ ×

PT50, 
PT1050 Deceleration time constant STB × ○ × × ○ × ○ ×

PT51, 
PT1051

S-pattern acceleration/
deceleration time constant STC × ○ × × ○ × ○ ×

PT52, 
PT1052 For manufacturer setting - × × × × × × × ×

PT53, 
PT1053 Torque slope TQS × × × × ○ × ○ ×

PT54, 
PT1054 For manufacturer setting - × × × × × × × ×

PT55, 
PT1055

Function selection T-8 *TOP8 × ○ × × × × × ×

Function selection T-10 *TOP1
0 × × × × ○ ○ ○ ×

PT56, 
PT1056

Home position return 
acceleration time constant HMA × ○ × × ○ ○ ○ ×

PT57, 
PT1057

Home position return 
deceleration time constant HMB × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(15)Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PL1 to PL72: Writing data to the RAM of a servo amplifier
• PL1001 to PL1072: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PT58 to 
PT61, 
PT1058 to 
PT1061

For manufacturer setting - × × × × × × × ×

PT62, 
PT1062

Remote register-based 
position/speed specifying 
method selection

*DSS × ○ × × × × × ×

PT63 to 
PT64, 
PT1063 to 
PT1064

For manufacturer setting - × × × × × × × ×

PT65, 
PT1065

Jog speed command
PVC

× ○ × × × × × ×

Profile speed command × × × × ○ × ○ ×

PT66, 
PT1066 Maximum profile speed MPVC × × × × ○ × ○ ×

PT67, 
PT1067 Speed limit VLMT × ○ × × ○ ○ ○ ×

PT68, 
PT1068 Function selection T-11 TOP1

1 × × × × ○ ○ ○ ×

PT69, 
PT1069

Home position shift distance 
(extension parameter) ZSTH × ○ × × × × × ×

PT70, 
PT1070 For manufacturer setting - × × × × × × × ×

PT71, 
PT1071

Travel distance after 
proximity dog (extension 
parameter)

DCTH × ○ × × × × × ×

PT72 to 
PT90, 
PT1072 to 
PT1090

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PL1, 
PL1001

Linear servo motor/DD motor 
function selection 1 **LIT1

○ ○ × × × × × ○

Function selection L-1 × × × × ○ × ○ ○

PL2, 
PL1002

Linear encoder resolution - 
Numerator **LIM ○ ○ × × ○ × ○ ○

PL3, 
PL1003

Linear encoder resolution 
setting Denominator **LID ○ ○ × × ○ × ○ ○

PL4, 
PL1004

Linear servo motor/DD motor 
function selection 2 *LIT2

○ ○ × × × × × ○

Function selection L-2 × × × × ○ × ○ ○

PL5, 
PL1005

Position deviation error 
detection level LB1 ○ ○ × × ○ × ○ ○

PL6, 
PL1006

Speed deviation error 
detection level LB2 ○ ○ × × ○ × ○ ○
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(16)Network setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PN1 to PN32: Writing data to the RAM of a servo amplifier
• PN1001 to PN1032: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PL7, 
PL1007

Torque/thrust deviation error 
detection level

LB3

○ ○ × × × × × ×

Torque deviation error 
detection level × × × × ○ × ○ ○

PL8, 
PL1008

Linear servo motor/DD motor 
function selection 3 *LIT3

○ ○ × × × × × ○

Function selection L-3 × × × × ○ × ○ ○

PL9, 
PL1009

Magnetic pole detection 
voltage level LPWM ○ ○ × × ○ × ○ ○

PL10 to 
PL16, 
PL1010 to 
PL1016

For manufacturer setting - × × × × × × × ×

PL17, 
PL1017

Magnetic pole detection - 
Minute position detection 
method - Function selection

LTSTS ○ ○ × × ○ × ○ ○

PL18, 
PL1018

Magnetic pole detection - 
Minute position detection 
method - Identification signal 
amplitude

IDLV ○ ○ × × ○ × ○ ○

PL19 to 
PL72, 
PL1019 to 
PL1072

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PN1, 
PN1001 For manufacturer setting - × × × × × × × ×

PN2, 
PN1002

Communication error 
detection time CERT × ○ × × ○ ○ ○ ×

PN3, 
PN1003

Communication mode 
setting for CC-Link IE 
communication

**NEM
D × ○ × × × × × ×

PN4, 
PN1004

CC-Link IE communication 
network number

**NEN
O × ○ × × × × × ×

PN5, 
PN1005

Communication error 
detection frequency setting CERI × ○ × × ○ ○ ○ ×

PN6, 
PN1006 Function selection N-1 NOP1 × ○ × × × × × ×

PN7 to 
PN12, 
PN1007 to 
PN1012

For manufacturer setting - × × × × × × × ×

PN13, 
PN1013 Network protocol setup NPS × × × × × × ○ ×
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(17)Position extension parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PVS1 to PVS32: Writing data to the RAM of a servo amplifier
• PVS1001 to PVS1032: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PN14 to 
PN19, 
PN1014 to 
PN1019

For manufacturer setting - × × × × × × × ×

PN20, 
PN1020

Automatic parameter backup 
update interval **PABI × × × × ○ ○ ○ ×

PN21, 
PN1021 For manufacturer setting - × × × × × × × ×

PN22, 
PN1022 Function selection N-5 NOP5 × × × × × × ○ ×

PN23 to 
PN32, 
PN1023 to 
PN1032

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PVS1, 
PVS1001

Profile speed command 
extension setting PVC2 × × × × ○ × ○ ×

PVS2, 
PVS1002 For manufacturer setting - × × × × × × × ×

PVS3, 
PVS1003

Maximum profile speed 
extension setting

MPVC
E × × × × ○ × ○ ×

PVS4, 
PVS1004 For manufacturer setting - × × × × × × × ×

PVS5, 
PVS1005 Profile acceleration PACC × × × × ○ × ○ ×

PVS6, 
PVS1006 For manufacturer setting - × × × × × × × ×

PVS7, 
PVS1007 Profile deceleration PDEC × × × × ○ × ○ ×

PVS8, 
PVS1008 For manufacturer setting - × × × × × × × ×

PVS9, 
PVS1009 Forced stop deceleration RSBD

EC × × × × ○ ○ ○ ×

PVS10, 
PVS1010 For manufacturer setting - × × × × × × × ×

PVS11, 
PVS1011

Home position return speed 
extension setting ZRFE × × × × ○ ○ ○ ×

PVS12, 
PVS1012 For manufacturer setting - × × × × × × × ×

PVS13, 
PVS1013

Creep speed extension 
setting CRFE × × × × ○ ○ ○ ×

PVS14, 
PVS1014 For manufacturer setting - × × × × × × × ×

PVS15, 
PVS1015

Home position return 
acceleration

HMAC
C × × × × ○ ○ ○ ×
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(18)Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

PVS16, 
PVS1016 For manufacturer setting - × × × × × × × ×

PVS17, 
PVS1017

Home position return 
deceleration

HMDE
C × × × × ○ ○ ○ ×

PVS18, 
PVS1018 For manufacturer setting - × × × × × × × ×

PVS19, 
PVS1019

Speed reached 2 output 
range extension setting

SA2R
E × × × × ○ × ○ ×

PVS20, 
PVS1020

Zero speed 2 level extension 
setting

ZSP2L
E × × × × ○ × ○ ×

PVS21, 
PVS1021 Speed limit extension setting VLMT

E × × × × ○ ○ ○ ×

PVS22, 
PVS1022 For manufacturer setting - × × × × × × × ×

PVS23, 
PVS1023

Speed unit conversion 
electronic gear numerator

*VCM
X × × × × ○ ○ ○ ×

PVS24, 
PVS1024

Speed unit conversion 
electronic gear denominator

*VCD
V × × × × ○ ○ ○ ×

PVS25, 
PVS1025

Acceleration unit conversion 
electronic gear nmrtr.

*ACM
X × × × × ○ ○ ○ ×

PVS26, 
PVS1026

Acceleration unit conversion 
electronic gear dnmntr.

*ACD
V × × × × ○ ○ ○ ×

PVS27 to 
PVS28, 
PVS1027 
to 
PVS1028

For manufacturer setting - × × × × × × × ×

PVS29, 
PVS1029 Acceleration limit ACCL

MT × × × × × × ○ ×

PVS30, 
PVS1030 For manufacturer setting - × × × × × × × ×

PVS31, 
PVS1031 Deceleration limit DECL

MT × × × × × × ○ ×

PVSS32, 
PVS1032 For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ST0 Cumulative feedback pulses - ○ ○ × × ○ ○ ○ ○

ST1 Servo motor speed - ○ ○ × × ○ ○ ○ ○

ST2 Droop pulses - ○ ○ × × ○ ○ ○ ○

ST3 Cumulative command pulses - ○ ○ × × ○ ○ ○ ○

ST4 Command pulse frequency - ○ ○ × × ○ ○ ○ ○

ST5 and 
ST6 For manufacturer setting - × × × × × × × ×

ST7 Regenerative load ratio - ○ ○ × × ○ ○ ○ ○

ST8 Effective load ratio - ○ ○ × × ○ ○ ○ ○

ST9 Peak load ratio - ○ ○ × × ○ ○ ○ ○

ST10

Instantaneous torque

-

○ ○ × × × × × ○

Torque/Instantaneous 
torque × × × × ○ ○ ○ ○
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ST11 Position within one-
revolution - ○ ○ × × ○ ○ ○ ○

ST12 ABS counter - ○ ○ × × ○ ○ ○ ○

ST13 Load to motor inertia ratio - ○ ○ × × ○ ○ ○ ○

ST14 Bus voltage - ○ ○ × × ○ ○ ○ ○

ST15 Load-side cumulative 
feedback pulses - ○ ○ × × ○ × ○ ○

ST16 Load-side encoder droop 
pulses - × ○ × × ○ × ○ ○

ST17 Load-side encoder 
information 1 - ○ ○ × × ○ × ○ ○

ST18 Load-side encoder 
information 2 - ○ ○ × × ○ × ○ ○

ST19 Analog monitor output 
voltage 1 - ○ ○ × × × × × ×

ST20 Analog monitor output 
voltage 2 - ○ ○ × × × × × ×

ST21 AB phase output pulse F/B 
integrated value - ○ ○ × × × × × ×

ST22 Temperature of servo motor 
thermistor - ○ ○ × × ○ ○ ○ ○

ST23

Servo motor-side cumulative 
feedback pulses (before 
gear)

- ○ ○ × × × × × ×

Cumulative feedback pulses 
(Motor unit) - × × × × ○ ○ ○ ○

ST24 Electrical angle - ○ ○ × × ○ × ○ ○

ST25 to 
ST29 For manufacturer setting - × × × × × × × ×

ST30 Motor/load side position 
difference - × ○ × × ○ × ○ ○

ST31 Motor/load side speed 
difference - × ○ × × ○ × ○ ○

ST32 Encoder inside temperature - ○ ○ × × ○ ○ ○ ○

ST33 Settling time - ○ ○ × × ○ ○ ○ ○

ST34 Oscillation detection 
frequency - ○ ○ × × ○ ○ ○ ○

ST35 Number of tough drive 
operations - ○ ○ × × ○ ○ ○ ○

ST36 to 
ST39 For manufacturer setting - × × × × × × × ×

ST40 Unit power consumption - ○ ○ × × ○ ○ ○ ○

ST41 Unit total power consumption - ○ ○ × × ○ ○ ○ ○

ST42
Position actual value - × ○ × × × × × ×

Current position - × × × × ○ ○ ○ ×

ST43 Command position - × ○ × × ○ ○ ○ ×

ST44

Command remaining 
distance - × ○ × × × × × ×

Remaining command 
distance - × × × × ○ ○ ○ ×

ST45
Point table No. - × ○ × × × × × ×

Command number - × × × × ○ ○ ○ ×

ST46 to 
ST48 For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(19)Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PE1 to PE88: Writing data to the RAM of a servo amplifier
• PE1001 to PE1088: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PE1, 
PE1001

Fully closed loop function 
selection 1

**FCT
1 ○ ○ × × ○ × ○ ○

PE2, 
PE1002 For manufacturer setting - × × × × × × × ×

PE3, 
PE1003

Fully closed loop function 
selection 2 *FCT2 ○ ○ × × ○ × ○ ○

PE4, 
PE1004

Fully closed loop ctrl. - F/B 
pls. elec. gear 1 nmrtr. **FBN ○ ○ × × ○ × ○ ○

PE5, 
PE1005

Fully closed loop ctrl. - F/B 
pls. elec. gear 1 dnmntr. **FBD ○ ○ × × ○ × ○ ○

PE6, 
PE1006

Fully closed loop ctrl. - Spd. 
dev. err. detection level BC1 ○ ○ × × ○ × ○ ○

PE7, 
PE1007

Fully closed loop ctrl. - Pos. 
dev. err. detection level BC2 ○ ○ × × ○ × ○ ○

PE8, 
PE1008

Fully closed dual feedback 
filter DUF ○ ○ × × ○ × ○ ○

PE9, 
PE1009 For manufacturer setting - × × × × ○ × ○ ×

PE10, 
PE1010

Fully closed loop function 
selection 3 FCT3 ○ ○ × × ○ × ○ ○

PE11 to 
PE33, 
PE1011 to 
PE1033

For manufacturer setting - × × × × × × × ×

PE34, 
PE1034

Fully closed loop control - 
Feedback pulse electronic 
gear 2 - Numerator

**FBN
2 ○ ○ × × × × × ×

PE35, 
PE1035

Fully closed loop control - 
Feedback pulse electronic 
gear 2 - Denominator

**FBD
2 ○ ○ × × × × × ×

PE36 to 
PE40, 
PE1036 to 
PE1040

For manufacturer setting - × × × × × × × ×

PE41, 
PE1041 Function selection E-3 EOP3 ○ ○ ○ ○ ○ ○ ○ ○

PE42 to 
PE43, 
PE1042 to 
PE1043

For manufacturer setting - × × × × × × × ×

PE44, 
PE1044

Lost motion positive side 
compensation value sel. LMCP ○ ○ ○ ○ ○ ○ ○ ○

PE45, 
PE1045

Lost motion negative side 
compensation value sel. LMCN ○ ○ ○ ○ ○ ○ ○ ○

PE46, 
PE1046 Lost motion filter setting LMFL

T ○ ○ ○ ○ ○ ○ ○ ○

PE47, 
PE1047 Torque offset TOF ○ ○ ○ ○ ○ ○ ○ ○

PE48, 
PE1048

Lost motion compensation 
function selection

*LMO
P ○ ○ ○ ○ ○ ○ ○ ○
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(20)Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• PF1 to PF99: Writing data to the RAM of a servo amplifier
• PF1001 to PF1099: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PE49, 
PE1049

Lost motion compensation 
timing LMCD ○ ○ ○ ○ ○ ○ ○ ○

PE50, 
PE1050

Lost motion compensation 
dead zone LMCT ○ ○ ○ ○ ○ ○ ○ ○

PE51, 
PE1051

Load-side encoder 
resolution setting

**EDV
2 × × × × × × ○ ○

PE52, 
PE1052 For manufacturer setting - × × × × × × × ×

PE53, 
PE1053 Maximum torque limit 1 TLMX

1 × × × × ○ ○ ○ ○

PE54 to 
PE64, 
PE1054 to 
PE1064

For manufacturer setting - × × × × × × × ×

PE65, 
PE1065

Collision detection friction 
torque TRUB × × × × × × × ○

PE66, 
PE1066

Collision detection viscosity 
friction torque VFTQ × × × × × × × ○

PE67, 
PE1067

Collision detection 
restoration torque CLTQ × × × × × × × ○

PE68, 
PE1068

Tandem control function 
selection

**TAN
C × × × × × × × ○

PE69, 
PE1069

Tandem control function 
setting

*TCO
P × × × × × × × ○

PE70, 
PE1070

Interaxial torque deviation 
permissible level TTRQ × × × × × × × ○

PE71, 
PE1071

Interaxial speed deviation 
permissible level TPOSI × × × × × × × ○

PE72 to 
PE88, 
PE1072 to 
PE1088

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

PF1, 
PF1001 For manufacturer setting - × × × × × × × ×

PF2, 
PF1002 Function selection F-2 *FOP2 ○ × × × ○ ○ ○ ○

PF3 to 
PF5, 
PF1003 to 
PF1005

For manufacturer setting - × × × × × × × ×

PF6, 
PF1006 Function selection F-5 *FOP5 ○ ○ ○ ○ ○ ○ ○ ○

PF7 to 
PF11, 
PF1007 to 
PF1011

For manufacturer setting - × × × × × × × ×
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PF12, 
PF1012

Electronic dynamic brake 
operating time DBT ○ ○ ○ ○ ○ ○ ○ ○

PF13 to 
PF17, 
PF1013 to 
PF1017

For manufacturer setting - × × × × × × × ×

PF18, 
PF1018

STO diagnostic error 
detection time

**STO
D × ○ × ○ ○ × ○ ○

PF19, 
PF1019

Friction failure prediction 
compen. coefficient 1 TSL × ○ × × ○ × ○ ○

PF20, 
PF1020

Friction failure prediction 
compen. coefficient 2 TIC × ○ × × ○ × ○ ○

PF21, 
PF1021

Drive recorder switching time 
setting DRT ○ ○ ○ ○ ○ ○ ○ ○

PF22, 
PF1022 For manufacturer setting - × × × × × × × ×

PF23, 
PF1023

Vibration tough drive - 
Oscillation detection level

OSCL
1 ○ ○ ○ ○ ○ ○ ○ ○

PF24, 
PF1024

Vibration tough drive function 
selection

*OSCL
2 ○ ○ ○ ○ × × × ×

Function selection F-9 *FOP9 × × × × ○ ○ ○ ○

PF25, 
PF1025

SEMI-F47 function - 
Instantaneous power failure 
detection time CVAT

○ ○ ○ ○ × × × ×

SEMI-F47 Inst pwr.fail.det.t. 
(Inst pwr.fail.tuf.drv.) × × × × ○ ○ ○ ○

PF26 to 
PF28, 
PF1026 to 
PF1028

For manufacturer setting - × × × × × × × ×

PF29, 
PF1029 Function selection F-10 *FOP1

0 × × × × × × ○ ○

PF30, 
PF1030 For manufacturer setting - × × × × × × × ×

PF31, 
PF1031

Machine diagnosis func. - 
Friction judgment speed( FRIC ○ ○ ○ ○ ○ ○ ○ ○

PF32, 
PF1032

Oscillation detection alarm 
time *VIBT × × × × ○ ○ ○ ○

PF33, 
PF1033 For manufacturer setting - × × × × × × × ×

PF34, 
PF1034

Machine diagnosis function 
selection *MFP × ○ × × ○ ○ ○ ○

PF35 to 
PF39, 
PF1035 to 
PF1039

For manufacturer setting - × × × × × × × ×

PF40, 
PF1040

Machine failure prediction 
parameter MFPP × ○ × × ○ × ○ ○

PF41, 
PF1041

Trouble prediction motor 
total move distance

FPMT

× × × × × × × ×

Failure prediction - Servo 
motor total move distance × × × × ○ × ○ ○

PF42, 
PF1042

Friction failure prediction 
average characteristic PAV × ○ × × ○ × ○ ○

PF43, 
PF1043

Friction failure prediction 
standard deviation PSD × ○ × × ○ × ○ ○

PF44, 
PF1044 For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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PF45, 
PF1045

Vibration failure prediction 
average characteristic VAV × ○ × × ○ × ○ ○

PF46, 
PF1046

Vibration failure prediction 
standard deviation

VSC × ○ × × × × × ×

VSD × × × × ○ × ○ ○

PF47, 
PF1047

Servo motor total move 
distance offset TMO × × × × ○ × ○ ○

PF48 to 
PF65, 
PF1048 to 
PF1065

For manufacturer setting - × × × × × × × ×

PF66, 
PF1066

Gear ratio setting for 
backlash estimation BLG × × × × ○ × ○ ○

PF67, 
PF1067 Backlash nominal value BLN × × × × ○ × ○ ○

PF68, 
PF1068

Backlash threshold 
magnification BLTT × × × × ○ × ○ ○

PF69, 
PF1069

Static friction failure 
prediction avg. characteristic

SPAV
2 × × × × ○ × ○ ○

PF70, 
PF1070

Static friction failure 
prediction standard deviation

SPSD
2 × × × × ○ × ○ ○

PF71, 
PF1071

Belt failure prediction 
function selection BFP × × × × ○ × ○ ○

PF72, 
PF1072 Belt tension at installation SBT × × × × ○ × ○ ○

PF73, 
PF1073 Belt tension at extension ABT × × × × ○ × ○ ○

PF74, 
PF1074 Static friction at installation SSF × × × × ○ × ○ ○

PF75, 
PF1075 Static friction at extension ASF × × × × ○ × ○ ○

PF76, 
PF1076 Belt tension error threshold BTS × × × × ○ × ○ ○

PF77 to 
PF78, 
PF1077 to 
PF1078

For manufacturer setting - × × × × × × × ×

PF79, 
PF1079 Event history setting EVS × × × × × × × ○

PF80, 
PF1080

Drive recorder Operation 
condition selection DRMC × × × × ○ ○ ○ ○

PF81, 
PF1081

Drive recorder Sampling 
operation selection DRMS × × × × ○ ○ ○ ○

PF82, 
PF1082

Drive recorder Trigger 
operation selection DRTM × × × × ○ ○ ○ ○

PF83, 
PF1083

Drive recorder Trigger 
operation axis common sel.

**DRT
AX × × × × ○ × ○ ○

PF84, 
PF1084

Drive recorder Trigger 
channel selection DRTC × × × × ○ ○ ○ ○

PF85, 
PF1085

Drive recorder Trigger level 
setting 1

DRTL
1 × × × × ○ ○ ○ ○

PF86, 
PF1086

Drive recorder Trigger level 
setting 2

DRTL
2 × × × × ○ ○ ○ ○

PF87, 
PF1087

Drive recorder Analog 
channel setting 1

DRAC
1 × × × × ○ ○ ○ ○

PF88, 
PF1088

Drive recorder Analog 
channel setting 2

DRAC
2 × × × × ○ ○ ○ ○

PF89, 
PF1089

Drive recorder Analog 
channel setting 3

DRAC
3 × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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(21)Network basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])
Set [Data Type] and [Format] as shown below for the objects for which this device is set.

• [Data Type]: [Unsigned BIN32]
• [Format]: [Hexadecimal]

○: Available
×: Not available

(22)Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

PF90, 
PF1090

Drive recorder Analog 
channel setting 4

DRAC
4 × × × × ○ ○ ○ ○

PF91, 
PF1091

Drive recorder Digital 
channel setting 1

DRDC
1 × × × × ○ ○ ○ ○

PF92, 
PF1092

Drive recorder Digital 
channel setting 2

DRDC
2 × × × × ○ ○ ○ ○

PF93, 
PF1093

Drive recorder Digital 
channel setting 3

DRDC
3 × × × × ○ ○ ○ ○

PF94, 
PF1094

Drive recorder Digital 
channel setting 4

DRDC
4 × × × × ○ ○ ○ ○

PF95, 
PF1095 Drive recorder History clear **DRC

LR × × × × ○ ○ ○ ○

PF96 to 
PF99, 
PF1096 to 
PF1099

For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

NPA1 IP address setting - × × × × ○ ○ ○ ×

NPA2 IP address - × × × × ○ ○ ○ ×

NPA3 Use prohibited - × × × × × × × ×

NPA4 Subnet mask - × × × × ○ ○ ○ ×

NPA5 Use prohibited - × × × × × × × ×

NPA6 For manufacturer setting - × × × × × × × ×

NPA7 Use prohibited - × × × × × × × ×

NPA8 Host name - × × × × ○ ○ ○ ×

NPA9 to 
NPA11 For manufacturer setting - × × × × × × × ×

NPA12 Communication speed - × × × × × × ○ ×

NPA2001 
to 
NPA2032

Host name expansion area - × × × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ALM0 Current alarm number - ○ ○ ○ ○ ○ ○ ○ ○

ALM1 Detailed data of current 
alarms - ○ ○ ○ ○ ○ ○ ○ ○

ALM2*1 Currently occurring alarm 
number and detail number - × × × × ○ ○ ○ ○

ALM11 Servo status(alarm) 
Cumulative feedback pulses - ○ ○ ○ ○ ○ ○ ○ ○
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ALM12 Servo status(alarm) Servo 
motor speed - ○ ○ ○ ○ ○ ○ ○ ○

ALM13 Servo status(alarm) Droop 
pulses - ○ ○ ○ ○ ○ ○ ○ ○

ALM14 Servo status(alarm) 
Cumulative command pulses - ○ ○ ○ ○ ○ ○ ○ ○

ALM15 Servo status(alarm) 
Command pulse frequency - ○ ○ ○ ○ ○ ○ ○ ○

ALM16 and 
ALM17 For manufacturer setting - × × × × × × × ×

ALM18 Servo status(alarm) 
Regenerative load ratio - ○ ○ ○ ○ ○ ○ ○ ○

ALM19 Servo status(alarm) Effective 
load ratio - ○ ○ ○ ○ ○ ○ ○ ○

ALM20 Servo status(alarm) Peak 
load ratio - ○ ○ ○ ○ ○ ○ ○ ○

ALM21

Servo status(alarm) 
Instantaneous torque

-

○ ○ ○ ○ × × × ×

Servo status(alarm) Torque/
Instantaneous torque × × × × ○ ○ ○ ○

ALM22 Servo status(alarm) Position 
within one-revolution - ○ ○ ○ ○ ○ ○ ○ ○

ALM23 Servo status(alarm) ABS 
counter - ○ ○ ○ ○ ○ ○ ○ ○

ALM24 Servo status(alarm) Load to 
motor inertia ratio - ○ ○ ○ ○ ○ ○ ○ ○

ALM25 Servo status(alarm) Bus 
voltage - ○ ○ ○ ○ ○ ○ ○ ○

ALM26
Servo status(alarm) Load-
side cumulative feedback 
pulses

- ○ ○ ○ ○ ○ × ○ ○

ALM27 Servo status(alarm) Load-
side droop pulses - × ○ × × ○ × ○ ○

ALM28 Servo status(alarm) Load-
side encoder information 1 - ○ ○ ○ ○ ○ × ○ ○

ALM29 Servo status(alarm) Load-
side encoder information 2 - ○ ○ ○ ○ ○ × ○ ○

ALM30 Servo status(alarm) Analog 
monitor output voltage 1 - ○ ○ ○ ○ × × × ×

ALM31 Servo status(alarm) Analog 
monitor output voltage 2 - ○ ○ ○ ○ × × × ×

ALM32
Servo status(alarm) AB 
phase output pulse F/B 
integrated value

- ○ ○ ○ ○ × × × ×

ALM33
Servo status(alarm) 
Temperature of servo motor 
thermistor

- ○ ○ ○ ○ ○ ○ ○ ○

ALM34

Servo status(alarm) Servo 
motor-side cumulative 
feedback pulses (before 
gear) -

○ ○ ○ ○ × × × ×

Servo status(alarm) 
Cumulative feedback pulses 
(Motor unit)

× × × × ○ ○ ○ ○

ALM35 Servo status(alarm) 
Electrical angle - ○ ○ ○ ○ ○ × ○ ○

ALM36 to 
ALM40 For manufacturer setting - × × × × × × × ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM41 Servo status(alarm) Motor/
load side position difference - × ○ × × ○ × ○ ○

ALM42 Servo status(alarm) Motor/
load side speed difference - × ○ × × ○ × ○ ○

ALM43

Servo status(alarm) Encoder 
inside temperature - ○ × ○ ○ × × × ×

Servo status(alarm) Encoder 
inside temperature - × ○ × × ○ ○ ○ ○

ALM44

Servo status(alarm) Settling 
time - ○ × ○ ○ × × × ×

Servo status(alarm) Settling 
time - × ○ × × ○ ○ ○ ○

ALM45

Servo status(alarm) 
Oscillation detection 
frequency

- ○ × ○ ○ × × × ×

Servo status(alarm) 
Oscillation detection 
frequency

- × ○ × × ○ ○ ○ ○

ALM46

Servo status(alarm) Number 
of tough drive operations - ○ × ○ ○ × × × ×

Servo status(alarm) Number 
of tough drive operations - × ○ × × ○ ○ ○ ○

ALM47 to 
ALM50 For manufacturer setting - × × × × × × × ×

ALM51 Servo status(alarm) Unit 
power consumption - ○ ○ ○ ○ ○ ○ ○ ○

ALM52 Servo status(alarm) Unit total 
power consumption - ○ ○ ○ ○ ○ ○ ○ ○

ALM53

Servo status(alarm) Position 
actual value - × ○ × × × × × ×

Servo status(alarm) Current 
position - × × × × ○ ○ ○ ×

ALM54 Servo status(alarm) 
Command position - × ○ × × ○ ○ ○ ×

ALM55

Servo status(alarm) 
Command remaining 
distance

- × ○ × × × × × ×

Servo status(alarm) 
Remaining command 
distance

- × × × × ○ ○ ○ ×

ALM56

Servo status(alarm) Point 
table No. - × ○ × × × × × ×

Servo status(alarm) 
Command number - × × × × ○ ○ ○ ×

ALM57 to 
ALM59 For manufacturer setting - × × × × × × × ×

ALM200 Alarm number from Alarm 
History most recent alarm - ○ ○ ○ ○ ○ ○ ○ ○

ALM201 Alarm number from Alarm 
History 1st alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM202 Alarm number from Alarm 
History 2nd alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM203 Alarm number from Alarm 
History 3rd alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM204 Alarm number from Alarm 
History 4th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM205 Alarm number from Alarm 
History 5th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM206 Alarm number from Alarm 
History 6th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM207 Alarm number from Alarm 
History 7th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM208 Alarm number from Alarm 
History 8th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM209 Alarm number from Alarm 
History 9th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM210 Alarm number from Alarm 
History 10th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM211 Alarm number from Alarm 
History 11th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM212 Alarm number from Alarm 
History 12th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM213 Alarm number from Alarm 
History 13th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM214 Alarm number from Alarm 
History 14th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM215 Alarm number from Alarm 
History 15th alarm in past - ○ ○ ○ ○ ○ ○ ○ ○

ALM220

Alarm occurrence time in 
alarm history most recent 
alarm

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: most recent 
alarm

- × × × × ○ ○ ○ ○

ALM221

Alarm occurrence time in 
alarm history 1st alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 1st alarm in 
past

- × × × × ○ ○ ○ ○

ALM222

Alarm occurrence time in 
alarm history 2nd alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 2nd alarm in 
past

- × × × × ○ ○ ○ ○

ALM223

Alarm occurrence time in 
alarm history 3rd alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 3rd alarm in 
past

- × × × × ○ ○ ○ ○

ALM224

Alarm occurrence time in 
alarm history 4th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 4th alarm in 
past

- × × × × ○ ○ ○ ○

ALM225

Alarm occurrence time in 
alarm history 5th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 5th alarm in 
past

- × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM226

Alarm occurrence time in 
alarm history 6th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 6th alarm in 
past

- × × × × ○ ○ ○ ○

ALM227

Alarm occurrence time in 
alarm history 7th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 7th alarm in 
past

- × × × × ○ ○ ○ ○

ALM228

Alarm occurrence time in 
alarm history 8th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 8th alarm in 
past

- × × × × ○ ○ ○ ○

ALM229

Alarm occurrence time in 
alarm history 9th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 9th alarm in 
past

- × × × × ○ ○ ○ ○

ALM230

Alarm occurrence time in 
alarm history 10th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 10th alarm 
in past

- × × × × ○ ○ ○ ○

ALM231

Alarm occurrence time in 
alarm history 11th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 11th alarm 
in past

- × × × × ○ ○ ○ ○

ALM232

Alarm occurrence time in 
alarm history 12th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 12th alarm 
in past

- × × × × ○ ○ ○ ○

ALM233

Alarm occurrence time in 
alarm history 13th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 13th alarm 
in past

- × × × × ○ ○ ○ ○

ALM234

Alarm occurrence time in 
alarm history 14th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 14th alarm 
in past

- × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM235

Alarm occurrence time in 
alarm history 15th alarm in 
past

- ○ ○ ○ ○ × × × ×

Alarm occurrence time 
(cumulative power-on time) 
in alarm history: 15th alarm 
in past

- × × × × ○ ○ ○ ○

ALM240

Detailed alarm from Alarm 
History most recent alarm - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: most recent alarm - × × × × ○ ○ ○ ○

ALM241

Detailed alarm from Alarm 
History 1st alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 1st alarm in past - × × × × ○ ○ ○ ○

ALM242

Detailed alarm from Alarm 
History 2nd alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 2nd alarm in past - × × × × ○ ○ ○ ○

ALM243

Detailed alarm from Alarm 
History 3rd alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 3rd alarm in past - × × × × ○ ○ ○ ○

ALM244

Detailed alarm from Alarm 
History 4th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 4th alarm in past - × × × × ○ ○ ○ ○

ALM245

Detailed alarm from Alarm 
History 5th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 5th alarm in past - × × × × ○ ○ ○ ○

ALM246

Detailed alarm from Alarm 
History 6th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 6th alarm in past - × × × × ○ ○ ○ ○

ALM247

Detailed alarm from Alarm 
History 7th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 7th alarm in past - × × × × ○ ○ ○ ○

ALM248

Detailed alarm from Alarm 
History 8th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 8th alarm in past - × × × × ○ ○ ○ ○

ALM249

Detailed alarm from Alarm 
History 9th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 9th alarm in past - × × × × ○ ○ ○ ○

ALM250

Detailed alarm from Alarm 
History 10th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 10th alarm in past - × × × × ○ ○ ○ ○

ALM251

Detailed alarm from Alarm 
History 11th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 11th alarm in past - × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM252

Detailed alarm from Alarm 
History 12th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 12th alarm in past - × × × × ○ ○ ○ ○

ALM253

Detailed alarm from Alarm 
History 13th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 13th alarm in past - × × × × ○ ○ ○ ○

ALM254

Detailed alarm from Alarm 
History 14th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 14th alarm in past - × × × × ○ ○ ○ ○

ALM255

Detailed alarm from Alarm 
History 15th alarm in past - ○ ○ ○ ○ × × × ×

Alarm detail number in alarm 
history: 15th alarm in past - × × × × ○ ○ ○ ○

ALM260
Alarm occurrence time (year, 
month) in alarm history: most 
recent alarm

- × × × × ○ ○ ○ ○

ALM261
Alarm occurrence time (year, 
month) in alarm history: 1st 
alarm in past

- × × × × ○ ○ ○ ○

ALM262
Alarm occurrence time (year, 
month) in alarm history: 2nd 
alarm in past

- × × × × ○ ○ ○ ○

ALM263
Alarm occurrence time (year, 
month) in alarm history: 3rd 
alarm in past

- × × × × ○ ○ ○ ○

ALM264
Alarm occurrence time (year, 
month) in alarm history: 4th 
alarm in past

- × × × × ○ ○ ○ ○

ALM265
Alarm occurrence time (year, 
month) in alarm history: 5th 
alarm in past

- × × × × ○ ○ ○ ○

ALM266
Alarm occurrence time (year, 
month) in alarm history: 6th 
alarm in past

- × × × × ○ ○ ○ ○

ALM267
Alarm occurrence time (year, 
month) in alarm history: 7th 
alarm in past

- × × × × ○ ○ ○ ○

ALM268
Alarm occurrence time (year, 
month) in alarm history: 8th 
alarm in past

- × × × × ○ ○ ○ ○

ALM269
Alarm occurrence time (year, 
month) in alarm history: 9th 
alarm in past

- × × × × ○ ○ ○ ○

ALM270
Alarm occurrence time (year, 
month) in alarm history: 10th 
alarm in past

- × × × × ○ ○ ○ ○

ALM271
Alarm occurrence time (year, 
month) in alarm history: 11th 
alarm in past

- × × × × ○ ○ ○ ○

ALM272
Alarm occurrence time (year, 
month) in alarm history: 12th 
alarm in past

- × × × × ○ ○ ○ ○

ALM273
Alarm occurrence time (year, 
month) in alarm history: 13th 
alarm in past

- × × × × ○ ○ ○ ○

ALM274
Alarm occurrence time (year, 
month) in alarm history: 14th 
alarm in past

- × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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ALM275
Alarm occurrence time (year, 
month) in alarm history: 15th 
alarm in past

- × × × × ○ ○ ○ ○

ALM280
Alarm occurrence time (date, 
hour) in alarm history: most 
recent alarm

- × × × × ○ ○ ○ ○

ALM281
Alarm occurrence time (date, 
hour) in alarm history: 1st 
alarm in past

- × × × × ○ ○ ○ ○

ALM282
Alarm occurrence time (date, 
hour) in alarm history: 2nd 
alarm in past

- × × × × ○ ○ ○ ○

ALM283
Alarm occurrence time (date, 
hour) in alarm history: 3rd 
alarm in past

- × × × × ○ ○ ○ ○

ALM284
Alarm occurrence time (date, 
hour) in alarm history: 4th 
alarm in past

- × × × × ○ ○ ○ ○

ALM285
Alarm occurrence time (date, 
hour) in alarm history: 5th 
alarm in past

- × × × × ○ ○ ○ ○

ALM286
Alarm occurrence time (date, 
hour) in alarm history: 6th 
alarm in past

- × × × × ○ ○ ○ ○

ALM287
Alarm occurrence time (date, 
hour) in alarm history: 7th 
alarm in past

- × × × × ○ ○ ○ ○

ALM288
Alarm occurrence time (date, 
hour) in alarm history: 8th 
alarm in past

- × × × × ○ ○ ○ ○

ALM289
Alarm occurrence time (date, 
hour) in alarm history: 9th 
alarm in past

- × × × × ○ ○ ○ ○

ALM290
Alarm occurrence time (date, 
hour) in alarm history: 10th 
alarm in past

- × × × × ○ ○ ○ ○

ALM291
Alarm occurrence time (date, 
hour) in alarm history: 11th 
alarm in past

- × × × × ○ ○ ○ ○

ALM292
Alarm occurrence time (date, 
hour) in alarm history: 12th 
alarm in past

- × × × × ○ ○ ○ ○

ALM293
Alarm occurrence time (date, 
hour) in alarm history: 13th 
alarm in past

- × × × × ○ ○ ○ ○

ALM294
Alarm occurrence time (date, 
hour) in alarm history: 14th 
alarm in past

- × × × × ○ ○ ○ ○

ALM295
Alarm occurrence time (date, 
hour) in alarm history: 15th 
alarm in past

- × × × × ○ ○ ○ ○

ALM300
Alarm occurrence time 
(minute, second) in alarm 
history: most recent alarm

- × × × × ○ ○ ○ ○

ALM301
Alarm occurrence time 
(minute, second) in alarm 
history: 1st alarm in past

- × × × × ○ ○ ○ ○

ALM302
Alarm occurrence time 
(minute, second) in alarm 
history: 2nd alarm in past

- × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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*1 Set [Data Type] and [Format] as shown below for the objects for which this device is set.
• [Data Type]: [Unsigned BIN32]
• [Format]: [Hexadecimal]

(23)Specifications of ALM260 to ALM275, ALM280 to ALM295, and ALM300 to ALM315 ([MELSEC iQ-R, 
RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
The date and time of alarm occurrence are stored in BCD code in the upper eight bits and lower eight bits of each device.
The time zone setting of the controller is applied to the date and time to be acquired.
Example) When the date and time of the most recent alarm occurrence is 15:30:20 May 15, 2020

In either of the following cases, 0 is stored.
• When the date and time of alarm occurrence are those of 1999 or earlier
• When the controller is MR-J5(W)-B(-RJ)

ALM303
Alarm occurrence time 
(minute, second) in alarm 
history: 3rd alarm in past

- × × × × ○ ○ ○ ○

ALM304
Alarm occurrence time 
(minute, second) in alarm 
history: 4th alarm in past

- × × × × ○ ○ ○ ○

ALM305
Alarm occurrence time 
(minute, second) in alarm 
history: 5th alarm in past

- × × × × ○ ○ ○ ○

ALM306
Alarm occurrence time 
(minute, second) in alarm 
history: 6th alarm in past

- × × × × ○ ○ ○ ○

ALM307
Alarm occurrence time 
(minute, second) in alarm 
history: 7th alarm in past

- × × × × ○ ○ ○ ○

ALM308
Alarm occurrence time 
(minute, second) in alarm 
history: 8th alarm in past

- × × × × ○ ○ ○ ○

ALM309
Alarm occurrence time 
(minute, second) in alarm 
history: 9th alarm in past

- × × × × ○ ○ ○ ○

ALM310
Alarm occurrence time 
(minute, second) in alarm 
history: 10th alarm in past

- × × × × ○ ○ ○ ○

ALM311
Alarm occurrence time 
(minute, second) in alarm 
history: 11th alarm in past

- × × × × ○ ○ ○ ○

ALM312
Alarm occurrence time 
(minute, second) in alarm 
history: 12th alarm in past

- × × × × ○ ○ ○ ○

ALM313
Alarm occurrence time 
(minute, second) in alarm 
history: 13th alarm in past

- × × × × ○ ○ ○ ○

ALM314
Alarm occurrence time 
(minute, second) in alarm 
history: 14th alarm in past

- × × × × ○ ○ ○ ○

ALM315
Alarm occurrence time 
(minute, second) in alarm 
history: 15th alarm in past

- × × × × ○ ○ ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ALM260
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 ALM280

Date and time of alarm occurrence:     2020 / 5 / 15     15:30:20 (Binary Coded Decimal)

ALM300
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
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(24)Point table (position) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• POS1 to POS255: Writing data to the RAM of a servo amplifier
• POS1001 to POS1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(25)Point table (speed) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• SPD1 to SPD255: Writing data to the RAM of a servo amplifier
• SPD1001 to SPD1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(26)Point table (acceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• ACT1 to ACT255: Writing data to the RAM of a servo amplifier
• ACT1001 to ACT1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(27)Point table (deceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• DCT1 to DCT255: Writing data to the RAM of a servo amplifier
• DCT1001 to DCT1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

POS1 to 
POS255, 
POS1001 
to 
POS1255

Point table/position data No. 
1 to No. 255 - × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

SPD1 to 
SPD255, 
SPD1001 
to 
SPD1255

Point table/speed data No. 1 
to No. 255 - × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ACT1 to 
ACT255, 
ACT1001 
to 
ACT1255

Point table/acceleration time 
constant No. 1 to No. 255 - × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

DCT1 to 
DCT255, 
DCT1001 
to 
DCT1255

Point table/deceleration time 
constant No. 1 to No. 255 - × ○ × × ○ ○ ○ ×
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(28)Point table (dwell) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• DWL1 to DWL255: Writing data to the RAM of a servo amplifier
• DWL1001 to DWL1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(29)Point table (auxiliary function) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• AUX1 to AUX255: Writing data to the RAM of a servo amplifier
• AUX1001 to AUX1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(30)Point table (M code) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
Use an appropriate device according to the write destination of the servo amplifier.

• MCD1 to MCD255: Writing data to the RAM of a servo amplifier
• MCD1001 to MCD1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(31)Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])
○: Available
×: Not available

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

DWL1 to 
DWL255, 
DWL1001 
to 
DWL1255

Point table/dwell No. 1 to No. 
255 - × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

AUX1 to 
AUX255, 
AUX1001 
to 
AUX1255

Point table/auxiliary function 
No. 1 to No. 255 - × ○ × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

MCD1 to 
MCD255, 
MCD1001 
to 
MCD1255

Point table/M code No. 1 to 
No. 255 - × × × × ○ ○ ○ ×

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

MD0 Machine diagnosis data, 
station number - ○ ○ ○ ○ ○ ○ ○ ○

MD1 Machine diagnosis data shift 
judgment (test mode) - ○ ○ ○ ○ ○ ○ ○ ○

MD2*1 Machine diagnosis data 
status - ○ ○ ○ ○ ○ ○ ○ ○
12 - 208 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
MD3*2
Machine diagnosis data 
coulomb friction torque in 
positive direction

- ○ ○ ○ ○ ○ ○ ○ ○

MD4*2
Machine diagnosis data 
friction torque at rated speed 
in positive direction

- ○ ○ ○ ○ ○ ○ ○ ○

MD5*2
Machine diagnosis data 
coulomb friction torque in 
negative direction

- ○ ○ ○ ○ ○ ○ ○ ○

MD6*2
Machine diagnosis data 
friction torque at rated speed 
in negative direction

- ○ ○ ○ ○ ○ ○ ○ ○

MD7*2
Machine diagnosis data 
oscillation frequency (motor 
is stopped)

- ○ ○ ○ ○ ○ ○ ○ ○

MD8*2
Machine diagnosis data 
vibration level (motor is 
stopped)

- ○ ○ ○ ○ ○ ○ ○ ○

MD9*2
Machine diagnosis data 
oscillation frequency (motor 
is operating)

- ○ ○ ○ ○ ○ ○ ○ ○

MD10*2
Machine diagnosis data 
vibration level (motor is 
operating)

- ○ ○ ○ ○ ○ ○ ○ ○

MD11
Machine diagnosis data, 
rated speed at forward or 
reverse rotation torque

- × ○ × × ○ ○ ○ ○

MD12

Machine diagnosis data 
friction based fault prediction 
prepare status

-

× ○ × × × × × ×

Machine diagnosis data: 
friction failure prediction - 
threshold creation progress

× × × × ○ ○*3 ○ ○

MD13

Machine diagnosis data 
vibration based fault 
prediction prepare status

-

× ○ × × × × × ×

Machine diagnosis data: 
vibration failure prediction - 
threshold creation progress

× × × × ○ ○*3 ○ ○

MD14 Machine diagnosis data 
motor total move distance - × ○ × × ○ ○*3 ○ ○

MD15

Machine diagnosis data, 
friction failure prediction, 
upper threshold at forward 
rotation torque, lower 
threshold at reverse rotation 
torque

- × ○ × × ○ ○*3 ○ ○

MD16

Machine diagnosis data, 
friction failure prediction, 
lower threshold at forward 
rotation torque, upper 
threshold at reverse rotation 
torque

- × ○ × × ○ ○*3 ○ ○

MD17

Machine diagnosis data 
vibration level threshold

-

× ○ × × × × × ×

Machine diagnosis data: 
vibration failure prediction - 
threshold acquisition

× × × × ○ ○*3 ○ ○

MD18 Machine diagnosis data 
trouble prediction status - × ○ × × ○ ○*3 ○ ○

MD19 Machine diagnosis data: Belt 
tension estimation value - × × × × ○ ○*3 ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)
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*1 While the servo amplifier is estimating the corresponding machine status in the machine diagnosis, do not write data to the 
parameters of the servo amplifier from another GOT.
Doing so may cause the servo amplifier to malfunction.

*2 When MD2 indicates that the servo amplifier does not complete the machine diagnosis (is estimating or warning of the 
machine status), do not monitor MD3 to MD6 (friction states) and MD7 to MD10 (vibration/oscillation states).
To start monitoring those devices upon the estimation completion, set [Trigger] in the applicable object settings.

*3 The commands assigned to MD12 to MD21 are not supported by MR-JET-G.
When the commands are used, the read values will be indefinite.

(32)Gear failure diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
○: Available
×: Not available

(33)Encoder communication circuit diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

MD20
Machine diagnosis data: 
static friction used in failure 
prediction

- × × × × ○ ○*3 ○ ○

MD21 Machine diagnosis data: Belt 
tension threshold estimation - × × × × ○ ○*3 ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

GFDS0 Backlash estimation 
(threshold) - × × × × ○ × ○ ○

GFDS1 Backlash estimation 
(estimation value) - × × × × ○ × ○ ○

GFDS2 Backlash estimation 
(estimation progress) - × × × × ○ × ○ ○

GFDS3 Backlash estimation (status) - × × × × ○ × ○ ○

GFDS4 Backlash error number - × × × × ○ × ○ ○

GFDS5 Backlash estimation move 
distance - × × × × ○ × ○ ○

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ECCDS0
CN2 encoder 
communication circuit 
diagnosis possibility

- × × × × ○ ○ ○ ○

ECCDS1
CN2L encoder 
communication circuit 
diagnosis possibility

- × × × × ○ ○ ○ ○

ECCDS2
CN2 encoder 
communication circuit 
diagnosis status

- × × × × ○ ○ ○ ○

ECCDS3
CN2L encoder 
communication circuit 
diagnosis status

- × × × × ○ ○ ○ ○

ECCDS4
CN2 encoder 
communication circuit 
diagnosis result

- × × × × ○ ○ ○ ○

ECCDS5
CN2L encoder 
communication circuit 
diagnosis result

- × × × × ○ ○ ○ ○
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(34)One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

*1 Writing is not available when a negative value is set for the device value.

(35)External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

(36)External input signal in MR-J5D□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

OTS0 One-touch tuning status 
confirmation - ○ ○ ○ ○ ○ ○ ○ ○

OTS1 Error code list - ○ ○ ○ ○ ○ ○ ○ ○

OTS2 Setting time - ○ ○ ○ ○ ○ ○ ○ ○

OTS3 Overshoot amount - ○ ○ ○ ○ ○ ○ ○ ○

OTS4 One-touch tuning command 
mode - × × × × ○ ○ ○ ○

OTS5 Load inertia moment ratio - × × × × ○ ○ ○ ○

OTS3000*1 Read/write permissible move 
distance - × × × × ○ ○ ○ ○

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
The input device statuses corresponding to the setting values 0000 to 001F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI1 Input device statuses -
The input device statuses corresponding to the setting values 0020 to 003F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI2 Input device statuses -
The input device statuses corresponding to the setting values 0040 to 005F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

DI4 Statuses of input devices switched on through 
communication -

The input device statuses switched on through communications (corresponding 
to the setting values 0000 to 001F) are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI5 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0020 to 003F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI6 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0040 to 005F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
The input device statuses corresponding to the setting values 0000 to 001F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI1 Input device statuses -
The input device statuses corresponding to the setting values 0020 to 003F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI2 Input device statuses -
The input device statuses corresponding to the setting values 0040 to 005F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)
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(37)External input signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(38)External input signal in MR-JET-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

DI4 Statuses of input devices switched on through 
communication -

The input device statuses switched on through communications (corresponding 
to the setting values 0000 to 001F) are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI5 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0020 to 003F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI6 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0040 to 005F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
The input device statuses corresponding to the setting values 0000 to 001F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI1 Input device statuses -
The input device statuses corresponding to the setting values 0020 to 003F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI2 Input device statuses -
The input device statuses corresponding to the setting values 0040 to 005F of the 
following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

DI4 Statuses of input devices switched on through 
communication -

The input device statuses switched on through communications (corresponding 
to the setting values 0000 to 001F) are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI5 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0020 to 003F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DI6 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0040 to 005F of the following) 
are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

Virtual device name Name Symbol

DI0 Input device statuses -

DI1 Input device statuses -

DI2 Input device statuses -

DI3 External input pin statuses -

DI4 Statuses of input devices switched on through communication -

DI5 Statuses of input devices switched on through communication -

DI6 Statuses of input devices switched on through communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier
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(39)External input signal in MR-JE-B and MR-JE-BF ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

(40)External input signal in MR-J4-GF(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(41)External input signal in MR-J4(W)-□B-RJ ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(42)External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - System information

DI1 Input device statuses - System information

DI2 Input device statuses - System information

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-JE-_B SERVO AMPLIFIER INSTRUCTION MANUAL

DI4 Statuses of input devices switched on through 
communication - System information

DI5 Statuses of input devices switched on through 
communication - System information

DI6 Statuses of input devices switched on through 
communication - System information

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - System information

DI1 Input device statuses - System information

DI2 Input device statuses - System information

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J4-_GF_(-RJ) Servo Amplifier Instruction Manual (Motion Mode)

DI4 Statuses of input devices switched on through 
communication - System information

DI5 Statuses of input devices switched on through 
communication - System information

DI6 Statuses of input devices switched on through 
communication - System information

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - System information

DI1 Input device statuses - System information

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J4-_B_(-RJ) SERVO AMPLIFIER INSTRUCTION MANUAL

DI4 Statuses of input devices switched on through 
communication - System information

DI5 Statuses of input devices switched on through 
communication - System information

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
The output device statuses corresponding to the setting values 8000 to 801F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)
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(43)External output signal in MR-J5D□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

(44)External output signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(45)External output signal in MR-JET-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

DO1 Output device statuses -
The output device statuses corresponding to the setting values 8020 to 803F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO2 Output device statuses -
The output device statuses corresponding to the setting values 8040 to 805F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
The output device statuses corresponding to the setting values 8000 to 801F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO1 Output device statuses -
The output device statuses corresponding to the setting values 8020 to 803F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO2 Output device statuses -
The output device statuses corresponding to the setting values 8040 to 805F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
The output device statuses corresponding to the setting values 8000 to 801F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO1 Output device statuses -
The output device statuses corresponding to the setting values 8020 to 803F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO2 Output device statuses -
The output device statuses corresponding to the setting values 8040 to 805F of 
the following are read.
Pr. PF91_Drive recorder - Digital channel setting 1 (DRDC1)

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

Virtual device name Name Symbol

DO0 Output device statuses -

DO1 Output device statuses -

DO2 Output device statuses -

DO4 External output pin statuses -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier
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(46)External output signal in MR-JE-B and MR-JE-BF ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

(47)External output signal in MR-J4-GF(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(48)External output signal in MR-J4(W)-□B-RJ ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

(49)Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - System information

DO1 Output device statuses - System information

DO2 Output device statuses - System information

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-JE-_B SERVO AMPLIFIER INSTRUCTION MANUAL

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - System information

DO1 Output device statuses - System information

DO2 Output device statuses - System information

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J4-_GF_(-RJ) Servo Amplifier Instruction Manual (Motion Mode)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - System information

DO1 Output device statuses - System information

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J4-_B_(-RJ) SERVO AMPLIFIER INSTRUCTION MANUAL

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

ALD0 Cumulative power-on time - ○ ○ ○ ○ ○ ○ ○ ○

ALD1 Number of inrush current 
switching times - ○ ○ ○ ○ ○ ○ ○ ○
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(50)Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

When using the input signal for test operation (for test operation), note the following.

(51)Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])
○: Available
×: Not available

When using the forced output of signal pin (for test operation), note the following.

(52)Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
○: Available
×: Not available

When using the set data (for test operation), note the following.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

TMI0 Input signal for test operation 
1 - ○ ○ ○ ○ ○ ○ ○ ○

TMI1 Input signal for test operation 
2 - ○ ○ ○ ○ ○ ○ ○ ○

TMI2 Input signal for test operation 
3 - × × × × × × × ×

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

TMO0 Forced output of signal pin - ○ ○ ○ ○ ○ ○ ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual 
device 
name

Name Symbo
l

MR-
J4(W)-
□B(-RJ)

MR-J4-
GF(-RJ) MR-JE-□B MR-JE-

□BF

MR-J5-
G(-RJ), 

MR-
J5W□-G

MR-JET-
G

MR-J5D□-
G

MR-J5-
□B(-RJ)

TMD0
Writes the speed (test mode)

-
○ ○ ○ ○ × × × ×

Motor speed × × × × ○ ○ ○ ○

TMD1

Writes the acceleration/
deceleration time constant 
(test mode) -

○ ○ ○ ○ × × × ×

Write acceleration/
deceleration time constant × × × × ○ ○ ○ ○

TMD3

Writes the moving distance 
(test mode) -

○ ○ ○ ○ × × × ×

Move distance × × × × ○ ○ ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

(1) When handling real numbers for virtual servo amplifier devices
For the servo amplifier, if a real number is written to a virtual device, only the integer portion of the number is stored into 
the device.
Example) When 12.34 is entered with the numerical input on the GOT, the value is written as 1234 to the device of the 
servo amplifier.
If the data type of the virtual servo amplifier device is set to [Real], the value after the writing may differ from the one 
before the writing.
Additionally, the monitoring process may take a longer time.
Therefore, select one of the following items as the data type of the virtual device.

• Signed 16-bit binary data
• Unsigned 16-bit binary data
• Signed 32-bit binary data
• Unsigned 32-bit binary data

When you use the value of the virtual servo amplifier device, remember that only the integer portion of the value is stored 
in the device.
To display a real number on the numerical display or numerical input object, set [Format] to [Real] and select [Adjust 
Decimal Point Range] in the object setting.

(2) Data type and format settings for using virtual servo amplifier devices
To specify virtual servo amplifier devices in the object setting or other settings, the data type and format must be set 
according to the notation of the values handled by the virtual devices.
For notation of the virtual device values, refer to the following.

➟Instruction manual for the servo amplifier used
MR Configurator2 HELP

When real numbers are stored in virtual devices, set the data type as shown below instead of setting [Real].
The following shows a setting example for using virtual servo amplifier devices for an object.
Example) When using a numerical display

(3) Specifying consecutive virtual servo amplifier devices
The GOT does not support writing/reading data to/from consecutive virtual servo amplifier devices.

Notation of the virtual device values Setting

Decimal number (positive values only)
• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 65536 or more)
• [Format]: [Unsigned Decimal]

Decimal number (positive and negative 
values)

• [Data Type]: [Signed BIN16] ([Signed BIN32] for -32769 or less, and 32768 or more)
• [Format]: [Signed Decimal]

Hexadecimal number
• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 0x10000 or more)
• [Format]: [Hexadecimal]

Decimal point notation (positive values 
only)

• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] as necessary)
• [Format]: [Real]
• [Digits (Integral)]: Set the number of digits in the integral portion.
• [Digits (Fractional)]: Set the number of digits in the fractional portion.
• [Adjust Decimal Point Range]: Selected

Decimal point notation (positive and 
negative values)

• [Data Type]: [Signed BIN16] ([Signed BIN32] as necessary)
• [Format]: [Real]
• [Digits (Integral)]: Set the number of digits in the integral portion.
• [Digits (Fractional)]: Set the number of digits in the fractional portion.
• [Adjust Decimal Point Range]: Selected

When the notation varies by digit

• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 0x10000 or more)
• [Format]: [Hexadecimal]
• On the [Operation/Script] tab, select [Data Operation] for [Operation Type], and set [Bit Mask] or 

[Bit Shift].
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■12 Virtual inverter devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

The following shows the correspondence between the virtual devices used in the GOT and the inverter data.

The lists of virtual devices shown in this section explain the FR-A800 Plus series and FR-E800 series models using the 
following abbreviations.

Virtual device name Reference

IOST ➟(1) I/O terminal monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

CMD

➟(2) Operation command ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

➟(3) Operation when turning on/off one of the CMD3 to CMD12 devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

➟(4) Operation when turning on/off one of the CMD48 to CMD52 devices (MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

AL ➟(5) Alarm history ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

LPr ➟(6) Parameter (32-bit) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OP ➟(7) Operation parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PV ➟(8) Current value monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Series Abbreviation Model

FR-A800 Plus series

CRN

FR-A8□0-CRN
FR-A8□2-CRN
FR-A8□0-E-CRN
FR-A8□2-E-CRN

R2R

FR-A8□0-R2R
FR-A8□2-R2R
FR-A8□0-E-R2R
FR-A8□2-E-R2R

AWH
FR-A8□0-AWH
FR-A8□0-E-AWH

LC
FR-A8□0-LC
FR-A8□0-E-LC

FR-E800 series
E800 FR-E8□0

E FR-E8□0-E
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(1) I/O terminal monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series FR-E700 series

E800 E FR-E7□0-NE

IOST1 Input terminal STF/DI0 ○*1 ○*1 ○*1 ○*1

IOST2 Input terminal STR/DI1 ○*1 ○*1 ○*1 ○*1

IOST3 Input terminal RL ○*1 ○*1 × ○*1

IOST4 Input terminal RM ○*1 ○*1 × ○*1

IOST5 Input terminal RH ○*1 ○*1 × ○*1

IOST6 Input terminal RT ○*1 × × ×

IOST7 Input terminal AU ○*1 × × ×

IOST8 Input terminal JOG ○*1 × × ×

IOST9 Input terminal CS ○*1 × × ×

IOST10 Input terminal MRS ○*1 ○*1 × ○*1

IOST11 Input terminal STOP ○*1 × × ×

IOST12 Input terminal RES ○*1 ○*1 × ○*1

IOST32 Output terminal RUN ○*1 ○*1 × ○*1

IOST33 Output terminal SU ○*1 × × ×

IOST34 Output terminal IPF ○*1 × × ×

IOST35 Output terminal OL ○*1 × × ×

IOST36 Output terminal FU ○*1 ○*1 × ○*1

IOST37 Output terminal ABC1 ○*1 ○*1 ○*1 ○*1

IOST38 Output terminal ABC2 ○*1 × × ×

IOST39 Output terminal SO ○ × × ×

IOST48 NET Y1 output × ○ *1*2 ○ *1*2 ×

IOST49 NET Y2 output × ○ *1*2 ○ *1*2 ×

IOST50 NET Y3 output × ○ *1*2 ○ *1*2 ×

IOST51 NET Y4 output × ○ *1*2 ○ *1*2 ×

IOST64 Option input terminal X0 ○ ○ ○ ×

IOST65 Option input terminal X1 ○ ○ ○ ×

IOST66 Option input terminal X2 ○ ○ ○ ×

IOST67 Option input terminal X3 ○ ○ ○ ×

IOST68 Option input terminal X4 ○ ○ ○ ×

IOST69 Option input terminal X5 ○ ○ ○ ×

IOST70 Option input terminal X6 ○ ○ ○ ×

IOST71 Option input terminal X7 ○ ○ ○ ×

IOST72 Option input terminal X8 ○ ○ ○ ×

IOST73 Option input terminal X9 ○ ○ ○ ×

IOST74 Option input terminal X10 ○ ○ ○ ×

IOST75 Option input terminal X11 ○ ○ ○ ×

IOST76 Option input terminal X12 ○ ○ ○ ×

IOST77 Option input terminal X13 ○ ○ ○ ×

IOST78 Option input terminal X14 ○ ○ ○ ×

IOST79 Option input terminal X15 ○ ○ ○ ×
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*1 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection) or Pr.190 to Pr.196 
or Pr.313 to Pr.322 (output terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*2 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

(2) Operation command ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

IOST80 Option input terminal DY ○ ○ ○ ×

IOST96 Option output terminal Y0/DO0 ○*1 ○*1 ○*1 ×

IOST97 Option output terminal Y1/DO1 ○*1 ○*1 ○*1 ×

IOST98 Option output terminal Y2/DO2 ○*1 ○*1 ○*1 ×

IOST99 Option output terminal Y3/DO3 ○*1 ○*1 ○*1 ×

IOST100 Option output terminal Y4/DO4 ○*1 ○*1 ○*1 ×

IOST101 Option output terminal Y5/DO5 ○*1 ○*1 ○*1 ×

IOST102 Option output terminal Y6/DO6 ○*1 ○*1 ○*1 ×

IOST103 Option output terminal RA1 ○*1 ○*1 ○*1 ×

IOST104 Option output terminal RA2 ○*1 ○*1 ○*1 ×

IOST105 Option output terminal RA3 ○*1 ○*1 ○*1 ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series FR-E700 series

E800 E FR-E7□0-NE

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

CMD0 Stop command ○ ○ ○

CMD1 Forward rotation command ○ ○ ○

CMD2 Reverse rotation command ○ ○ ○

CMD3*1 RL terminal ○*2 ○*2 ○*2

CMD4*1 RM terminal ○*2 ○*2 ○*2

CMD5*1 RH terminal ○*2 ○*2 ○*2

CMD6*1 RT terminal ○*2 ○ ○

CMD7*1 AU terminal ○*2 ○ ○

CMD8*1 JOG terminal ○ *2*3 ○ ×

CMD9*1 CS terminal ○ *2*3 × ×

CMD10*1 MRS terminal ○*2 ○*2 ○*2

CMD11*1 STOP terminal ○ *2*3 × ×

CMD12*1 RES terminal ○ *2*3 ○ *2*3 ○*2

CMD16 Alarm history clear ○ ○ ○

CMD24 Inverter reset ○ ○ ○

CMD32 Parameter clear ○ ○ ○

CMD33 Parameter clear (communication 
parameters are not cleared) ○ ○ ○

CMD34 All parameter clear ○ ○ ○

CMD35
All parameter clear 
(communication parameters are 
not cleared)

○ ○ ○

CMD48 NET X1 input × ○*2*3*4 ×

CMD49 NET X2 input × ○*2*3*4 ×
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*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the settings of Pr.180 to Pr.189 (input terminal function selection).

*4 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

When using the operation command, note the following.

(3) Operation when turning on/off one of the CMD3 to CMD12 devices ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
The CMD3 to CMD12 devices cannot be controlled simultaneously.
When you turn on/off one of the CMD3 to CMD12 devices, the rest of these devices are turned off.
Use OP4 to control multiple devices from CMD3 to CMD12 simultaneously.
The following shows the relationship between CMD3 to CMD12 and OP4.

Example) Turning on the CMD3 (RL terminal) and CMD12 (RES terminal) devices
For a hexadecimal value, write 0201.
For a decimal value, write 513.

(4) Operation when turning on/off one of the CMD48 to CMD52 devices (MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
The CMD48 to CMD52 devices cannot be controlled simultaneously.
When you turn on/off one of the CMD48 to CMD52 devices, the rest of these devices are turned off.
Use OP5 to control multiple devices from CMD48 to CMD52 simultaneously.
The following shows the relationship between CMD48 to CMD52 and OP5.

CMD50 NET X3 input × ○*2*3*4 ×

CMD51 NET X4 input × ○*2*3*4 ×

CMD52 NET X5 input × ○*2*3*4 ×

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Operation when a CMD device is turned on

➟(3) Operation when turning on/off one of the CMD3 to CMD12 devices ([MELSEC iQ-R, 
RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

(4) Operation when turning on/off one of the CMD48 to CMD52 devices (MELSEC iQ-R, RnMT/
NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

OP4
b15 b7 b0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

CMD3
CMD4
CMD5
CMD6
CMD7
CMD8
CMD9
CMD10
CMD11
CMD12

b31 b23
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
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Example) Turing on the CMD48 (NET X1 input) and CMD52 (NET X5 input) devices
For a hexadecimal value, write 0011.
For a decimal value, write 17.

(5) Alarm history ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

OP5
b15 b7 b0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

CMD48
CMD49
CMD50
CMD51
CMD52

b31 b23
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

AL0 Current fault ○ ○ ○

AL1 Current warning 1 × ○ ×

AL2 Current warning 2 × ○ ×

AL100 Faults history 1 (symbol) ○ ○ ○

AL101 Faults history 1 (output frequency) ○ ○ ○

AL102 Faults history 1 (output current) ○ ○ ○

AL103 Faults history 1 (output voltage) ○ ○ ○

AL104 Faults history 1 (energization time) ○ ○ ○

AL105 Faults history 1 (year) ○ ○ ×

AL106 Faults history 1 (month) ○ ○ ×

AL107 Faults history 1 (day) ○ ○ ×

AL108 Faults history 1 (hour) ○ ○ ×

AL109 Faults history 1 (minute) ○ ○ ×

AL200 Faults history 2 (symbol) ○ ○ ○

AL201 Faults history 2 (output frequency) ○ ○ ○

AL202 Faults history 2 (output current) ○ ○ ○

AL203 Faults history 2 (output voltage) ○ ○ ○

AL204 Faults history 2 (energization time) ○ ○ ○

AL205 Faults history 2 (year) ○ ○ ×

AL206 Faults history 2 (month) ○ ○ ×

AL207 Faults history 2 (day) ○ ○ ×

AL208 Faults history 2 (hour) ○ ○ ×

AL209 Faults history 2 (minute) ○ ○ ×

AL300 Faults history 3 (symbol) ○ ○ ○

AL301 Faults history 3 (output frequency) ○ ○ ○

AL302 Faults history 3 (output current) ○ ○ ○

AL303 Faults history 3 (output voltage) ○ ○ ○

AL304 Faults history 3 (energization time) ○ ○ ○

AL305 Faults history 3 (year) ○ ○ ×

AL306 Faults history 3 (month) ○ ○ ×

AL307 Faults history 3 (day) ○ ○ ×

AL308 Faults history 3 (hour) ○ ○ ×

AL309 Faults history 3 (minute) ○ ○ ×

AL400 Faults history 4 (symbol) ○ ○ ○
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AL401 Faults history 4 (output frequency) ○ ○ ○

AL402 Faults history 4 (output current) ○ ○ ○

AL403 Faults history 4 (output voltage) ○ ○ ○

AL404 Faults history 4 (energization time) ○ ○ ○

AL405 Faults history 4 (year) ○ ○ ×

AL406 Faults history 4 (month) ○ ○ ×

AL407 Faults history 4 (day) ○ ○ ×

AL408 Faults history 4 (hour) ○ ○ ×

AL409 Faults history 4 (minute) ○ ○ ×

AL500 Faults history 5 (symbol) ○ ○ ○

AL501 Faults history 5 (output frequency) ○ ○ ○

AL502 Faults history 5 (output current) ○ ○ ○

AL503 Faults history 5 (output voltage) ○ ○ ○

AL504 Faults history 5 (energization time) ○ ○ ○

AL505 Faults history 5 (year) ○ ○ ×

AL506 Faults history 5 (month) ○ ○ ×

AL507 Faults history 5 (day) ○ ○ ×

AL508 Faults history 5 (hour) ○ ○ ×

AL509 Faults history 5 (minute) ○ ○ ×

AL600 Faults history 6 (symbol) ○ ○ ○

AL601 Faults history 6 (output frequency) ○ ○ ○

AL602 Faults history 6 (output current) ○ ○ ○

AL603 Faults history 6 (output voltage) ○ ○ ○

AL604 Faults history 6 (energization time) ○ ○ ○

AL605 Faults history 6 (year) ○ ○ ×

AL606 Faults history 6 (month) ○ ○ ×

AL607 Faults history 6 (day) ○ ○ ×

AL608 Faults history 6 (hour) ○ ○ ×

AL609 Faults history 6 (minute) ○ ○ ×

AL700 Faults history 7 (symbol) ○ ○ ○

AL701 Faults history 7 (output frequency) ○ ○ ○

AL702 Faults history 7 (output current) ○ ○ ○

AL703 Faults history 7 (output voltage) ○ ○ ○

AL704 Faults history 7 (energization time) ○ ○ ○

AL705 Faults history 7 (year) ○ ○ ×

AL706 Faults history 7 (month) ○ ○ ×

AL707 Faults history 7 (day) ○ ○ ×

AL708 Faults history 7 (hour) ○ ○ ×

AL709 Faults history 7 (minute) ○ ○ ×

AL800 Faults history 8 (symbol) ○ ○ ○

AL801 Faults history 8 (output frequency) ○ ○ ○

AL802 Faults history 8 (output current) ○ ○ ○

AL803 Faults history 8 (output voltage) ○ ○ ○

AL804 Faults history 8 (energization time) ○ ○ ○

AL805 Faults history 8 (year) ○ ○ ×

AL806 Faults history 8 (month) ○ ○ ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE
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(6) Parameter (32-bit) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
The virtual device numbers (LPr) used in the GOT correspond to the inverter parameter numbers.
For the inverter parameters, refer to the following.

➟Manual of the inverter used
When using a parameter (32-bit), note the following.

(7) Operation parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the settings of Pr.180 to Pr.189 (input terminal function selection).

*4 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

AL807 Faults history 8 (day) ○ ○ ×

AL808 Faults history 8 (hour) ○ ○ ×

AL809 Faults history 8 (minute) ○ ○ ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

Precautions Description

When setting [8888] or [9999] to a 32-bit 
parameter (Lpr) of an inverter

[8888] and [9999] are used for particular purposes.
From the GOT, if you set these numbers to a 32-bit parameter that can accept a value with a 
fractional part, you are recommended to set the data type to [Real].

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

OP0 Operation frequency(RAM) ○ ○ ○

OP1 Operation frequency (EEPROM) ○ ○ ○

OP2 Operation mode ○ ○ ○

OP3 Operating status ○ ○ ○

OP4*1*2*

3

- Input terminal command

○ ○ ○

b0 CMD3: RL terminal

b1 CMD4: RM terminal

b2 CMD5: RH terminal

b3 CMD6: RT terminal

b4 CMD7: AU terminal

b5 CMD8: JOG terminal

b6 CMD9: CS terminal

b7 CMD10: MRS terminal

b8 CMD11: STOP terminal

b9 CMD12: RES terminal

OP5*2

- Input terminal command (extend)

× ○*4 ×

b0 CMD48: NET X1 input

b1 CMD49: NET X2 input

b2 CMD50: NET X3 input

b3 CMD51: NET X4 input

b4 CMD52: NET X5 input
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(8) Current value monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
○: Available
×: Not available

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE

PV1
Output frequency/speed × × × ○ × × × × ○

Output frequency ○ ○ ○ × ○ ○ ○ ○ ×

PV2 Output current ○ ○ ○ ○ ○ ○ ○ ○ ○

PV3 Output voltage ○ ○ ○ ○ ○ ○ ○ ○ ○

PV5

Frequency setting value/
speed setting × × × ○ × × × × ○

Frequency setting value ○ ○ ○ × ○ ○ ○ ○ ×

PV6
Speed/machine speed ○ ○ ○ ○ × ○ ○ ○ ×

Operation speed × × × × ○ × × × ×

PV7 Motor torque ○ ○ ○ ○ ○ ○ ○ ○ ○

PV8 Converter output voltage ○ ○ ○ ○ ○ ○ ○ ○ ○

PV9 Regenerative brake duty ○ ○ ○ ○ ○ × ○ ○ ○

PV10 Electronic thermal O/L relay 
load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV11 Output current peak value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV12 Converter output voltage 
peak value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV13 Input power ○ ○ ○ ○ ○ ○ × × ×

PV14 Output power ○ ○ ○ ○ ○ ○ ○ ○ ○

PV17 Load meter ○ ○ ○ ○ ○ ○ ○ ○ ×

PV18 Motor excitation current ○ ○ ○ ○ ○ ○ ○ ○ ×

PV19

Position pulse ○ ○ × × ○ × × × ×

Analog output signal for 
dancer tension control × × ○ ○ × × × × ×

PV20 Cumulative energization 
time ○ ○ ○ ○ ○ ○ ○ ○ ○

PV22
Orientation status ○ ○ × × ○ × × × ×

Winding diameter × × ○ ○ × × × × ×

PV23 Actual operation time ○ ○ ○ ○ ○ ○ ○ ○ ○

PV24 Motor load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV25 Cumulative power ○ ○ ○ ○ ○ ○ ○ ○ ○

PV26

Position command (lower 
digits) × ○ × × × × × × ×

Line speed command × × ○ ○ × × × × ×

PV27

Position command (upper 
digits) × ○ × × × × × × ×

Actual line speed × × ○ ○ × × × × ×

PV28

Current position (lower 
digits) × ○ × × × × × × ×

Dancer compensation 
speed × × ○ ○ × × × × ×

PV29

Current position (upper 
digits) × ○ × × × × × × ×

Winding length (upper + 
lower) × × ○ ○ × × × × ×

PV30

Droop pulse (lower digits) × ○ × × × × × × ×

Analog output signal 2 for 
dancer tension control × × ○ ○ × × × × ×
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PV31
Droop pulse (upper digits) × ○ × × × × × × ×

Line speed pulse monitor × × ○ ○ × × × × ×

PV32 Torque command ○ ○ ○ ○ ○ × ○ ○ ×

PV33 Torque current command ○ ○ ○ ○ ○ × ○ ○ ×

PV34 Motor output ○ ○ ○ ○ ○ ○ × × ×

PV35 Feedback pulse ○ ○ ○ ○ ○ × × × ×

PV36

Torque (positive polarity for 
driving torque/negative 
polarity for regenerative 
braking torque)

○ ○ ○ ○ ○ × × × ×

PV38 Trace status × ○ ○ ○ × × × × ×

PV39 SSCNET III communication 
status ○ ○ × × ○ × × × ×

PV40 PLC function user monitor 1 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV41 PLC function user monitor 2 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV42 PLC function user monitor 3 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV43 Station number (RS-485 
terminals) × ○ ○ ○ × × × × ×

PV44 Station number (PU) × ○ ○ ○ × × × × ×

PV45 Station number (CC-Link) × ○ ○ ○ × × × × ×

PV46 Motor temperature ○ ○ ○ ○ ○ × × × ×

PV50 Energy saving effect ○ ○ ○ ○ ○ ○ ○ ○ ×

PV51 Cumulative energy saving ○ ○ ○ ○ ○ ○ ○ ○ ×

PV52 PID set point ○ ○ ○ ○ ○ ○ ○ ○ ○

PV53 PID measured value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV54 PID deviation ○ ○ ○ ○ ○ ○ ○ ○ ○

PV61 Motor thermal load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV62 Inverter thermal load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV63
Cumulative power 2 × × × × × × × × ○

Winding length (upper) × × ○ ○ × × × × ×

PV64 PTC thermistor resistance ○ ○ ○ ○ ○ ○ × × ×

PV67 PID measured value 2 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV68 Emergency drive status × × × × × × × × ×

PV69 PID input pressure value × × × × × ○ × × ×

PV71 Cumulative pulse ○ ○ ○ ○ ○ × × × ×

PV72 Cumulative pulse overflow 
times ○ ○ ○ ○ ○ × × × ×

PV73 Cumulative pulse (control 
terminal option) ○ ○ ○ ○ ○ × × × ×

PV74
Cumulative pulse overflow 
times (control terminal 
option)

○ ○ ○ ○ ○ × × × ×

PV75 Multi-revolution counter ○ ○ × × ○ × × × ×

PV77 32-bit cumulative energy 
(lower 16 bits) × × × ○ × × × × ×

PV78 32-bit cumulative energy 
(upper 16 bits) × × × ○ × × × × ×

PV79 32-bit cumulative energy 
(lower 16 bits) × × × ○ × × × × ×

PV80 32-bit cumulative energy 
(upper 16 bits) × × × ○ × × × × ×

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE
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PV81

BACnet reception status × × × × × ○ × × ×

Tension command after 
taper compensation × × ○ ○ × × × × ×

PV82

BACnet token pass counter × × × × × ○ × × ×

Winding diameter 
compensation torque 
command

× × ○ ○ × × × × ×

PV83

BACnet valid APDU 
counter × × × × × ○ × × ×

Inertia compensation × × ○ ○ × × × × ×

PV84

BACnet communication 
error counter × × × × × ○ × × ×

Mechanical loss 
compensation × × ○ ○ × × × × ×

PV85

BACnet terminal FM/CA 
output level × × × × × ○ × × ×

Terminal 1 input voltage × × ○ ○ × × × × ×

PV86

BACnet terminal AM output 
level × × × × × ○ × × ×

Terminal 1 input after 
calibration (%) × × ○ ○ × × × × ×

PV87 Remote output value 1 ○ ○ ○ ○ ○ ○ × × ×

PV88 Remote output value 2 ○ ○ ○ ○ ○ ○ × × ×

PV89 Remote output value 3 ○ ○ ○ ○ ○ ○ × × ×

PV90 Remote output value 4 ○ ○ ○ ○ ○ ○ × × ×

PV91 PID manipulated variable ○ ○ ○ ○ ○ ○ ○ ○ ×

PV92

Second PID set point ○ ○ × × ○ ○ × × ×

PID torque control actual 
tension × × ○ × × × × × ×

PV93

Second PID measured 
value ○ ○ × × ○ ○ × × ×

PID torque control 
manipulated tension × × ○ × × × × × ×

PV94 Second PID deviation ○ ○ × × ○ ○ × × ×

PV95 Second PID measured 
value 2 ○ ○ × × ○ ○ × × ×

PV96 Second PID manipulated 
variable ○ ○ × × ○ ○ × × ×

PV97

Dancer main set speed
(For FR-E800 and FR-
E800-E, dancer main speed 
setting)

○ ○ × × ○ × ○ ○ ×

Winding diameter 
compensation speed × × ○ ○ × × × × ×

PV98 Control circuit temperature ○ ○ ○ ○ ○ ○ × × ×

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE
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12.3.3 [MELSEC iQ-L]

■1 Monitoring-supported bit devices ([MELSEC iQ-L])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.3 ■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-L])
○: Available
×: Not available

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([MELSEC iQ-L])

➟■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-L])

➟■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-L])

Specifications of word devices

➟■4 Monitoring-supported word devices ([MELSEC iQ-L])

➟■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-L])

➟■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-L])

Specifications of double-word 
devices

➟■7 Monitoring-supported double-word devices ([MELSEC iQ-L])

➟■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-L])

➟■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-L])

Specifications of virtual servo 
amplifier devices

➟■10 Virtual servo amplifier devices ([MELSEC iQ-L])

➟■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-L])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 2FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 2FFF ○ ○

B Link relay Hexadeci
mal 000000 to D69FFF ○ ○

M Internal relay Decimal 0 to 14065663 ○ ○

L Latch relay Decimal 0 to 32767 ○ ○

S*3 Step relay Decimal 0 to 16383 × ×

F Annunciator Decimal 0 to 32767 ○ ○

TC Timer coil Decimal 0 to 781407 ○
○
(Not usable as 
word data)

TT Timer contact Decimal 0 to 781407 ○
○
(Not usable as 
word data)

CC Counter coil Decimal 0 to 781407 ○
○
(Not usable as 
word data)

CT Counter contact Decimal 0 to 781407 ○
○
(Not usable as 
word data)

SC Retentive timer coil Decimal 0 to 781407 ○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.3 ■10 Virtual servo amplifier devices ([MELSEC iQ-L])

*3 If a bit-specified word device is used in the random read processing, GT SoftGOT2000 (Single channel) or GT Simulator3 
uses the value of the bit device in block No. 0 only.
The bit device status depends on the SFC program status (active or inactive). When the SFC program is inactive, the bit 

device is off (stores 0).
If a step relay (S) is used in the random read processing, specify the relevant step relay (block) (BLS) on GT SoftGOT2000 

or GT Simulator3.

SS Retentive timer contact Decimal 0 to 781407 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 000000 to D69FFF ○ ○

SM Special relay Decimal 0 to 4095 ○ ○

LTC Long timer coil Decimal 0 to 219775 ○
○
(Not usable as 
word data)

LTT Long timer contact Decimal 0 to 219775 ○
○
(Not usable as 
word data)

LCC Long counter coil Decimal 0 to 413695 ○
○
(Not usable as 
word data)

LCT Long counter contact Decimal 0 to 413695 ○
○
(Not usable as 
word data)

LSC Long retentive timer coil Decimal 0 to 219775 ○
○
(Not usable as 
word data)

LSS Long retentive timer contact Decimal 0 to 219775 ○
○
(Not usable as 
word data)

BL SFC block Decimal 0 to 319 × ×

BLS Step relay (block) Decimal

BL(SFC block No.)-S(Device)
Notation example: BL1-S3
• SFC Block No. (decimal): 0 to 319
• Device (decimal): 0 to 511

× ×

SP*2 Servo amplifier request Decimal ➟12.3.3 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

OM*2 Operation mode selection Decimal ➟12.3.3 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

TMB*2 Instruction demand (for test 
operation) Decimal ➟12.3.3 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-L])
× ×

OTI*2 One-touch tuning instruction Decimal ➟12.3.3 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
When [MELSEC iQ-L] is selected, the connection type is fixed as shown in the following table.

The following shows the notation and setting range of virtual devices.

For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-L])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

Device name Device notation and setting range Notation example

SP [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-SP(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A64-SP0

OM [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

UFF-A64-OM0

TMB [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

UFF-A64-TMB1

OTI [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A64-OTI0

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-
12 - 230 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
■4 Monitoring-supported word devices ([MELSEC iQ-L])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.3 ■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-L])
○: Available
×: Not available

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/- -/- R/- R/- -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

LTC R/W -/- -/- -/- -/-

LTT R/W -/- -/- -/- -/-

LCC R/W -/- -/- -/- -/-

LCT R/W -/- -/- -/- -/-

LSC R/W -/- -/- -/- -/-

LSS R/W -/- -/- -/- -/-

BL R/W -/- -/- -/- -/-

BLS R/W -/- -/- -/- -/-

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN Timer current value Decimal 0 to 781407 ○ ○

CN Counter current value Decimal 0 to 781407 ○ ○

SN Retentive timer current value Decimal 0 to 781407 ○ ○

D Data register Decimal 0 to 879103 ○ ○

SD Special register Decimal 0 to 4095 ○ ○

W Link register Hexadeci
mal 00000 to D69FF ○ ○

SW Link special register Hexadeci
mal 00000 to D69FF ○ ○

R File register Decimal 0 to 32767 ○ ○

ER Extension file register(Block) Decimal

ER(R block)-(Device)
Notation example: ER255-100
• R block (decimal): 0 to 255
• Device (decimal): 0 to 32767

○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.3 ■10 Virtual servo amplifier devices ([MELSEC iQ-L])

ZR Extension file register Decimal 0 to 819199 ○ ○

Z Index register Decimal 0 to 23 ○
○
(Not usable as bit 
data)

G Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-G100
• Unit No. (hexadecimal): 00 to FF
• Device (decimal): 0 to 65535
For the module No., set the first 2 digits of 
the 3-digit number that represents the start 
I/O number of the buffer memory for the 
intelligent function module.

○ ○

PA*2 Basic parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PB*2 Gain filter parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PC*2 Extension setting parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PD*2 I/O setting parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PL*2 Linear servo motor/DD motor 
setting parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-L])
× ×

ST*2 Status display Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PE*2 Extension setting No.2 parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

PF*2 Extension setting No.3 parameter Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

ALM*2 Alarm (current alarm J4A extend) Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

ALM*2 Alarm (alarm history J4A extend) Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

MD*2 Machine diagnosis data Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

OTS*2 One-touch tuning data Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

DI*2 External input signal Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

DO*2 External output signal Decimal ➟12.3.3 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-L])

× ×

U3E0G CPU buffer memory access 
device Decimal

U3E0-G(Device)
Notation example: U3E0-G100
• Device (decimal): 0 to 65535

○ ○

RD Refresh data register Decimal 0 to 1048575 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
12 - 232 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
When [MELSEC iQ-L] is selected, the connection type is fixed as shown in the following table.

The following shows the notation and setting range of virtual devices.

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

Device name Device notation and setting range Notation example

PA [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PA(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 32, 1001 to 1032

UFF-A64-PA1

PB [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A64-PB1

PC [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PC(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 80, 1001 to 1080

UFF-A64-PC1

PD [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 48, 1001 to 1048

UFF-A64-PD1

PL [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PL(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 48, 1001 to 1048

UFF-A64-PL1

ST [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ST(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

UFF-A64-ST0

PE [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PE(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A64-PE1

PF [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PF(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A64-PF1
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-L])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

ALM [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 11 to 59, 200 to 215, 220 to 235, 240 

to 255

UFF-A64-ALM0

MD [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-MD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 18

UFF-A64-MD0

OTS [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 3

UFF-A64-OTS0

DI [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A64-DI0

DO [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

UFF-A64-DO0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W R/W R/W

SD R/W R/W R/W R/W

W R/W R/W R/W R/W

SW R/W R/W -/- R/W

R R/W R/W R/W R/W

ER R/W R/W R/W R/W

ZR R/W R/W R/W R/W

Z R/W R/W -/- -/-

G R/W R/W R/W R/W

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PL R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-
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■7 Monitoring-supported double-word devices ([MELSEC iQ-L])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.3 ■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-L])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.3 ■10 Virtual servo amplifier devices ([MELSEC iQ-L])

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

MD R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI R/- R/W -/- -/-

DO R/- R/- -/- -/-

U3E0G R/W R/W R/W R/W

RD R/W R/W R/W R/W

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LTN Long timer current value Decimal 0 to 219775 × ×

LCN Long counter current value Decimal 0 to 413695 × ×

LSN Long retentive timer current value Decimal 0 to 219775 × ×

ZZ Index register (32 bits) Decimal 0 to 22 × ×

LZ Index register (32 bits) Decimal 0 to 11 × ×

ALD*2 Life diagnosis Decimal
➟12.3.3 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC 
iQ-L])

× ×

TMI*2
Input signal for test operation (for 
test operation) Decimal

➟12.3.3 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-L])

× ×

TMO*2 Forced output of signal pin (for test 
operation) Decimal

➟12.3.3 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-L])

× ×

TMD*2 Set data (for test operation) Decimal
➟12.3.3 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC 
iQ-L])

× ×
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■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
When [MELSEC iQ-L] is selected, the connection type is fixed as shown in the following table.

The following shows the notation and setting range of virtual devices.

For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

Device name Device notation and setting range Notation example

ALD [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A64-ALD0

TMI [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

UFF-A64-TMI0

TMO [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0

UFF-A64-TMO0

TMD [Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 64 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

UFF-A64-TMD0
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■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-L])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■10 Virtual servo amplifier devices ([MELSEC iQ-L])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LTN -/- R/W -/- -/-

LCN -/- R/W -/- -/-

LSN -/- R/W -/- -/-

ZZ -/- R/W -/- -/-

LZ -/- R/W -/- -/-

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟12.3.2 ■10 (1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

OM ➟12.3.2 ■10 (2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

TMB ➟12.3.2 ■10 (3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

OTI ➟12.3.2 ■10 (4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PA ➟12.3.2 ■10 (7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PB ➟12.3.2 ■10 (8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PC ➟12.3.2 ■10 (9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PD ➟12.3.2 ■10 (10) I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PL ➟12.3.2 ■10 (15) Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/NC/
RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ST ➟12.3.2 ■10 (18) Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PE ➟12.3.2 ■10 (19) Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

PF ➟12.3.2 ■10 (20) Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

ALM ➟12.3.2 ■10 (22) Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

MD ➟12.3.2 ■10 (31) Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

OTS ➟12.3.2 ■10 (34) One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

DI ➟12.3.2 ■10 (35) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

DO ➟12.3.2 ■10 (42) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])
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■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-L])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

ALD ➟12.3.2 ■10 (49) Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMI ➟12.3.2 ■10 (50) Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

TMO ➟12.3.2 ■10 (51) Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

TMD ➟12.3.2 ■10 (52) Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

Virtual device name Reference
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12.3.4 [MELSEC iQ-F]

■1 Monitoring-supported bit devices ([MELSEC iQ-F])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.4 ■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-F])
○: Available
×: Not available

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([MELSEC iQ-F])

➟■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-F])

➟■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-F])

Specifications of word devices

➟■4 Monitoring-supported word devices ([MELSEC iQ-F])

➟■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-F])

➟■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-F])

Specifications of double-word 
devices

➟■7 Monitoring-supported double-word devices ([MELSEC iQ-F])

➟■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-F])

➟■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-F])

Specifications of virtual servo 
amplifier devices

➟■10 Virtual servo amplifier devices ([MELSEC iQ-F])

➟■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-F])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Octal 0000 to 1777 ○ ○

Y Output relay Octal 0000 to 1777 ○ ○

B Link relay Hexadeci
mal 0000 to 7FFF ○ ○

M Internal relay Decimal 0 to 32767 ○ ○

L Latch relay Decimal 0 to 32767 ○ ○

S Step relay Decimal 0 to 4095 ○ ○

F Annunciator Decimal 0 to 32767 ○ ○

TC Timer coil Decimal 0 to 1023 ○
○
(Not usable as 
word data)

TT Timer contact Decimal 0 to 1023 ○
○
(Not usable as 
word data)

CC Counter coil Decimal 0 to 1023 ○
○
(Not usable as 
word data)

CT Counter contact Decimal 0 to 1023 ○
○
(Not usable as 
word data)

SC Retentive timer coil Decimal 0 to 1023 ○
○
(Not usable as 
word data)

SS Retentive timer contact Decimal 0 to 1023 ○
○
(Not usable as 
word data)
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 239



*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.4 ■10 Virtual servo amplifier devices ([MELSEC iQ-F])

*3 The target device of the host station can be monitored only.
Monitoring the target device of any other station causes a system error.

SB Link special relay Hexadeci
mal 0000 to 7FFF ○ ○

SM Special relay Decimal 0 to 9999 ○ ○

RX*3 Remote input Hexadeci
mal 0000 to 3FFF ○ ○

RY*3 Remote output Hexadeci
mal 0000 to 3FFF ○ ○

LCC Long counter coil Decimal 0 to 1023 ○
○
(Not usable as 
word data)

LCT Long counter contact Decimal 0 to 1023 ○
○
(Not usable as 
word data)

BL SFC block Decimal 0 to 31 × ×

BLS Step relay (block) Decimal 0 to 511 × ×

SP*2 Servo amplifier request Decimal ➟12.3.4 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

OM*2 Operation mode selection Decimal ➟12.3.4 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

TMB*2 Instruction demand (for test 
operation) Decimal ➟12.3.4 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-F])
× ×

OTI*2 One-touch tuning instruction Decimal ➟12.3.4 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

GFDI*2 Gear failure diagnosis instruction Decimal ➟12.3.4 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ECCDI*2
Encoder communication circuit 
diagnosis instruction Decimal ➟12.3.4 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC iQ-F])
× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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■2 Setting virtual bit devices for servo amplifiers ([MELSEC iQ-F])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Motion Module(CCIET)]

Select this item to connect the GOT through a Motion module (FX5-nSSC-G).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.

Device name Device notation and setting range Notation example

SP

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-SP(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

U10-A32-SP0

[Motion Module(CCIET)]

AA(Axis designation)-SP(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

AA3-SP0

OM

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OM(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

U10-A32-OM0

[Motion Module(CCIET)]

AA(Axis designation)-OM(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 4 to 5

AA3-OM0

TMB

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMB(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

U10-A32-TMB1

[Motion Module(CCIET)]

AA(Axis designation)-TMB(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 6

AA3-TMB1
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-F])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

OTI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTI(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

U10-A32-OTI0

[Motion Module(CCIET)]

AA(Axis designation)-OTI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-OTI0

GFDI [Motion Module(CCIET)]

AA(Axis designation)-GFDI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-GFDI0

ECCDI [Motion Module(CCIET)]

AA(Axis designation)-ECCDI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-ECCDI0

Device name Device notation and setting range Notation example

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

LCC R/W -/- -/- -/- -/-

LCT R/W -/- -/- -/- -/-

BL R/W -/- -/- -/- -/-

BLS R/W -/- -/- -/- -/-

SP -/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([MELSEC iQ-F])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.4 ■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-F])
○: Available
×: Not available

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

GFDI -/W -/- -/- -/- -/-

ECCDI -/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN Timer current value Decimal 0 to 1023 ○ ○

CN Counter current value Decimal 0 to 1023 ○ ○

SN Retentive timer current value Decimal 0 to 1023 ○ ○

D Data register Decimal 0 to 7999 ○ ○

SD Special register Decimal 0 to 11999 ○ ○

W Link register Hexadeci
mal 0000 to 7FFF ○ ○

SW Link special register Hexadeci
mal 0000 to 7FFF ○ ○

R*4 File register Decimal 0 to 32767 ○ ○

Z Index register Decimal 0 to 23 ○
○
(Not usable as bit 
data)

G*5 Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: U10-G100
• Unit No. (hexadecimal): 01 to FF
• Device (decimal): 0 to 262143
For the unit No., set the module number of 
the intelligent function module.

○ ○

Ww*3 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

Wr*3 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

PA*2 Basic parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PB*2 Gain filter parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PC*2 Extension setting parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PD*2 I/O setting parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PO*2 Option unit parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PS*2 Special parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PU*2 Multi encoder parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.

PT*2 Positioning control parameters Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PL*2*6

Motor extension setting parameter

Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×Linear servo motor/DD motor 
setting parameter

PN*2 Network setting parameters Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PVS*2*7 Position extension parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ST*2 Status display Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PE*2 Extension setting No.2 parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

PF*2 Extension setting No.3 parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

NPA*2 Network basic parameter Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ALM*2 Alarm (current alarm J4A extend) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ALM*2 Alarm (alarm history J4A extend) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

POS*2 Point table (position) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

SPD*2 Point table (speed) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ACT*2 Point table (acceleration time 
constant) Decimal ➟12.3.4 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-F])
× ×

DCT*2 Point table (deceleration time 
constant) Decimal ➟12.3.4 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-F])
× ×

DWL*2 Point table (dwell) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

AUX*2 Point table (auxiliary function) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

MCD*2 Point table (M code) Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

MD*2 Machine diagnosis data Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

GFDS*2 Gear failure diagnosis data Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

ECCDS*

2
Encoder communication circuit 
diagnosis data Decimal ➟12.3.4 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC iQ-F])
× ×

OTS*2 One-touch tuning data Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

DI*2 External input signal Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

DO*2 External output signal Decimal ➟12.3.4 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC iQ-F])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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➟12.3.4 ■10 Virtual servo amplifier devices ([MELSEC iQ-F])
*3 The target device of the host station can be monitored only.

Monitoring the target device of any other station causes a system error.
*4 Available for the file register of block No. switched with the RSET instruction.
*5 Only the intelligent function module on the station connected to GOT can be specified.

Set the buffer memory within the address range of the buffer memory existing in the intelligent function module.
*6 The device name depends on the servo amplifier.

MR-J5-G(-RJ) or MR-J5W□-G: Motor extension setting parameter
Other than MR-J5-G(-RJ) or MR-J5W□-G: Linear servo motor/DD motor setting parameter

*7 PVS is a virtual device corresponding to the servo parameter (PV) of MR-J5-G(-RJ), MR-J5W □ -G, and MR-JET-G.
Use the virtual device (PVS) to read/write data from/to the servo parameter (PV).

■5 Setting virtual word devices for servo amplifiers ([MELSEC iQ-F])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Motion Module(CCIET)]

Select this item to connect the GOT through a Motion module (FX5-nSSC-G).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.

Device name Device notation and setting range Notation example

PA

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PA(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

U10-A32-PA1

[Motion Module(CCIET)]

AA(Axis designation)-PA(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

AA3-PA1

PB

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PB(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 92, 1001 to 1092

U10-A32-PB1

[Motion Module(CCIET)]

AA(Axis designation)-PB(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 92, 1001 to 1092

AA3-PB1
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PC

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PC(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 90, 1001 to 1090

U10-A32-PC1

[Motion Module(CCIET)]

AA(Axis designation)-PC(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

AA3-PC1

PD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PD(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

U10-A32-PD1

[Motion Module(CCIET)]

AA(Axis designation)-PD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

AA3-PD1

PO [Motion Module(CCIET)]

AA(Axis designation)-PO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 2, 1001 to 1002

AA3-PO1

PS [Motion Module(CCIET)]

AA(Axis designation)-PS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

AA3-PS1

PU [Motion Module(CCIET)]

AA(Axis designation)-PU(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

AA3-PU1

PT [Motion Module(CCIET)]

AA(Axis designation)-PT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

AA3-PT1

PL

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PL(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

U10-A32-PL1

[Motion Module(CCIET)]

AA(Axis designation)-PL(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

AA3-PL1

PN [Motion Module(CCIET)]

AA(Axis designation)-PN(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

AA3-PN1

PVS [Motion Module(CCIET)]

AA(Axis designation)-PVS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

AA3-PVS1

ST

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ST(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

U10-A32-ST0

[Motion Module(CCIET)]

AA(Axis designation)-ST(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 48

AA3-ST0

PE

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PE(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 88, 1001 to 1088

U10-A32-PE1

[Motion Module(CCIET)]

AA(Axis designation)-PE(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 88, 1001 to 1088

AA3-PE1

Device name Device notation and setting range Notation example
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PF

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PF(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

U10-A32-PF1

[Motion Module(CCIET)]

AA(Axis designation)-PF(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

AA3-PF1

NPA [Motion Module(CCIET)]
NPA(Device)
• Device (decimal): 1 to 12, 2001 to 2032

NPA1

ALM

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALM(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

U10-A32-ALM0

[Motion Module(CCIET)]

AA(Axis designation)-ALM(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

AA3-ALM0

POS [Motion Module(CCIET)]

AA(Axis designation)-POS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-POS1

SPD [Motion Module(CCIET)]

AA(Axis designation)-SPD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-SPD1

ACT [Motion Module(CCIET)]

AA(Axis designation)-ACT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-ACT1

DCT [Motion Module(CCIET)]

AA(Axis designation)-DCT(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-DCT1

DWL [Motion Module(CCIET)]

AA(Axis designation)-DWL(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-DWL1

AUX [Motion Module(CCIET)]

AA(Axis designation)-AUX(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-AUX1

MCD [Motion Module(CCIET)]

AA(Axis designation)-MCD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 255, 1001 to 1255

AA3-MCD1

MD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-MD(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 21

U10-A32-MD0

[Motion Module(CCIET)]

AA(Axis designation)-MD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 21

AA3-MD0

GFDS [Motion Module(CCIET)]

AA(Axis designation)-GFDS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-GFDS0

ECCDS [Motion Module(CCIET)]

AA(Axis designation)-ECCDS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

AA3-ECCDS0

Device name Device notation and setting range Notation example
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-F])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

OTS

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTS(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5, 3000

U10-A32-OTS0

[Motion Module(CCIET)]

AA(Axis designation)-OTS(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5, 3000

AA3-OTS0

DI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DI(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

U10-A32-DI0

[Motion Module(CCIET)]

AA(Axis designation)-DI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

AA3-DI0

DO

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DO(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

U10-A32-DO0

[Motion Module(CCIET)]

AA(Axis designation)-DO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 4

AA3-DO0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W R/W R/W

SD R/W R/W R/W R/W

W R/W R/W R/W R/W

SW R/W R/W -/- R/W

R R/W R/W R/W R/W

Z R/W R/W -/- -/-

G R/W R/W R/W R/W

Ww R/W R/W R/W R/W

Wr R/W R/W R/W R/W

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PO R/W R/W -/- -/-
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■7 Monitoring-supported double-word devices ([MELSEC iQ-F])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.4 ■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-F])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

PS R/W R/W -/- -/-

PU R/W R/W -/- -/-

PT R/W R/W -/- -/-

PL R/W R/W -/- -/-

PN R/W R/W -/- -/-

PVS R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

NPA R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MCD R/W R/W -/- -/-

MD R/- R/- -/- -/-

GFDS R/- R/- -/- -/-

ECCDS R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LCN Long counter current value Decimal 0 to 1023 × ×

LZ Index register (32 bits) Decimal 0 to 11 × ×

ALD*2 Life diagnosis Decimal
➟12.3.4 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC 
iQ-F])

× ×

TMI*2
Input signal for test operation (for 
test operation) Decimal

➟12.3.4 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-F])

× ×

TMO*2 Forced output of signal pin (for test 
operation) Decimal

➟12.3.4 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC 
iQ-F])

× ×

TMD*2 Set data (for test operation) Decimal
➟12.3.4 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC 
iQ-F])

× ×
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*2 Virtual servo amplifier device
For the details, refer to the following.
➟12.3.4 ■10 Virtual servo amplifier devices ([MELSEC iQ-F])

■8 Setting virtual double-word devices for servo amplifiers ([MELSEC iQ-F])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Simple Motion(SSCNET III/H)]

Connection through a Simple Motion module
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Motion Module(CCIET)]

Select this item to connect the GOT through a Motion module (FX5-nSSC-G).
After the selection, set a device that enables axis designation to display the following 
item.
• [Axis Designation]: Set the axis to be monitored.

Device name Device notation and setting range Notation example

ALD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALD(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

U10-A32-ALD0

[Motion Module(CCIET)]

AA(Axis designation)-ALD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

AA3-ALD0

TMI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMI(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

U10-A32-TMI0

[Motion Module(CCIET)]

AA(Axis designation)-TMI(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2

AA3-TMI0

TMO

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMO(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0

U10-A32-TMO0

[Motion Module(CCIET)]

AA(Axis designation)-TMO(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0

AA3-TMO0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■9 Availability of writing/reading data to/from double-word devices ([MELSEC iQ-F])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■10 Virtual servo amplifier devices ([MELSEC iQ-F])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

TMD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMD(Device)
• Unit No. (hexadecimal): 01 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

U10-A32-TMD0

[Motion Module(CCIET)]

AA(Axis designation)-TMD(Device)
• Axis designation (decimal): 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1, 3

AA3-TMD0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LCN -/- R/W -/- -/-

LZ -/- R/W -/- -/-

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟12.3.2 ■10 (1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

OM ➟12.3.2 ■10 (2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

TMB ➟12.3.2 ■10 (3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

OTI ➟12.3.2 ■10 (4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

GFDI ➟12.3.2 ■10 (5) Gear failure diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ECCDI ➟12.3.2 ■10 (6) Encoder communication circuit diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

PA ➟12.3.2 ■10 (7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PB ➟12.3.2 ■10 (8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PC ➟12.3.2 ■10 (9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PD ➟12.3.2 ■10 (10) I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PO ➟12.3.2 ■10 (11) Option unit parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

PS ➟12.3.2 ■10 (12) Special parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
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PU ➟12.3.2 ■10 (13) Multi encoder parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

PT ➟12.3.2 ■10 (14) Positioning control parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PL ➟12.3.2 ■10 (15) Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/NC/
RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PN ➟12.3.2 ■10 (16) Network setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PVS ➟12.3.2 ■10 (17) Position extension parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ST ➟12.3.2 ■10 (18) Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PE ➟12.3.2 ■10 (19) Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

PF ➟12.3.2 ■10 (20) Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

NPA ➟12.3.2 ■10 (21) Network basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ALM ➟12.3.2 ■10 (22) Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

POS ➟12.3.2 ■10 (24) Point table (position) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

SPD ➟12.3.2 ■10 (25) Point table (speed) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ACT ➟12.3.2 ■10 (26) Point table (acceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

DCT ➟12.3.2 ■10 (27) Point table (deceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

DWL ➟12.3.2 ■10 (28) Point table (dwell) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AUX ➟12.3.2 ■10 (29) Point table (auxiliary function) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

MCD ➟12.3.2 ■10 (30) Point table (M code) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

MD ➟12.3.2 ■10 (31) Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

GFDS ➟12.3.2 ■10 (32) Gear failure diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ECCDS ➟12.3.2 ■10 (33) Encoder communication circuit diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

OTS ➟12.3.2 ■10 (34) One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

DI ➟12.3.2 ■10 (35) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

DO ➟12.3.2 ■10 (42) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

ALD ➟12.3.2 ■10 (49) Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMI ➟12.3.2 ■10 (50) Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

TMO ➟12.3.2 ■10 (51) Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

TMD ➟12.3.2 ■10 (52) Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

Virtual device name Reference
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■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-F])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])
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12.3.5 [MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/
DSR, CRnD-700]

■1 Monitoring-supported bit devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.5 ■3 Availability of writing/reading data to/from bit devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

○: Available
×: Not available

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, 
Q17nD/M/DR/DSR, CRnD-700])

➟■2 Setting virtual bit devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

➟■3 Availability of writing/reading data to/from bit devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-
700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

Specifications of word devices

➟■4 Monitoring-supported word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-
Q, Q17nD/M/DR/DSR, CRnD-700])

➟■5 Setting virtual word devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

➟■6 Availability of writing/reading data to/from word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

Specifications of double-word 
devices

➟■7 Monitoring-supported double-word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

➟■8 Setting virtual double-word devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

➟■9 Availability of writing/reading data to/from double-word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/
DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

Specifications of virtual servo 
amplifier devices

➟■10 Virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, 
Q17nD/M/DR/DSR, CRnD-700])

➟■11 Precautions for virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

Specifications of virtual inverter 
devices

➟■12 Virtual inverter devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/
M/DR/DSR, CRnD-700])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 3FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 3FFF ○ ○

B Link relay Hexadeci
mal 00000 to 9FFFF ○ ○

M*4 Internal relay Decimal 0 to 61439 ○ ○

L Latch relay Decimal 0 to 32767 ○ ○

S Step relay Decimal 0 to 32767 ○ ○

F Annunciator Decimal 0 to 32767 ○ ○
12 - 254 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

TC*4 Timer coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

TT*4 Timer contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)

CC*4 Counter coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

CT*4 Counter contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)

SC*4 Retentive timer coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

SS*4 Retentive timer contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 0000 to 7FFF ○ ○

SM Special relay Decimal 0 to 2255 ○ ○

RX Remote input Hexadeci
mal 0000 to 3FFF ○ ○

RY Remote output Hexadeci
mal 0000 to 3FFF ○ ○

LB Link relay Hexadeci
mal 0000 to 7FFF ○ ○

SP*2 Servo amplifier request Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

OM*2 Operation mode selection Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

TMB*2 Instruction demand (for test 
operation) Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

OTI*2 One-touch tuning instruction Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

IOST*3 I/O terminal monitor Decimal 0 to 127 × ×

CMD*3 Operation command Decimal 0 to 63 × ×

GFDI*2 Gear failure diagnosis instruction Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

ECCDI*2
Encoder communication circuit 
diagnosis instruction Decimal

➟12.3.5 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.5 ■10 Virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/

M/DR/DSR, CRnD-700])
*3 Virtual inverter device

For the details, refer to the following.
➟12.3.5 ■12 Virtual inverter devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/

DSR, CRnD-700])
*4 Do not use the local device set in a MELSEC-Q system.

Doing so disables the correct monitoring.

■2 Setting virtual bit devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (QD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (QD77GF).

Device name Device notation and setting range Notation example

SP

[Motion Controller(SSCNET III/H)]
A(Axis No.)-SP(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

A32-SP0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-SP(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A32-SP0

[Master Module(CCIEF)]
SP(Device)
• Device (decimal): 0 to 6

SP0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OM

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OM(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

A32-OM0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

UFF-A32-OM0

[Master Module(CCIEF)]
OM(Device)
• Device (decimal): 0 to 2, 4 to 5

OM0

TMB

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMB(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

A32-TMB1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

UFF-A32-TMB1

[Master Module(CCIEF)]
TMB(Device)
• Device (decimal): 1 to 6

TMB1

OTI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OTI(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A32-OTI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A32-OTI0

[Master Module(CCIEF)]
OTI(Device)
• Device (decimal): 0 to 5

OTI0

GFDI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-GFDI(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A32-GFDI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-GFDI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A32-GFDI0

ECCDI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ECCDI(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A32-ECCDI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ECCDI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A32-ECCDI0

Device name Device notation and setting range Notation example
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■3 Availability of writing/reading data to/from bit devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/
DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
The GOT can only read data from the device when the QS001CPU is used.
To write data to the consecutive devices of a Q172DR(CR750-Q), use the Q172DR(CR750-Q) with firmware version R6b 
or later.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

LB R/W -/- R/W R/W -/-

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

IOST R/- -/- -/- -/- -/-

CMD -/W -/- -/- -/- -/-

GFDI -/W -/- -/- -/- -/-

ECCDI -/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.5 ■6 Availability of writing/reading data to/from word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/
DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN*6 Timer current value Decimal 0 to 32767 ○ ○

CN*6 Counter current value Decimal 0 to 32767 ○ ○

SN*6 Retentive timer current value Decimal 0 to 32767 ○ ○

D*3*5*6 Data register Decimal 0 to 4910079 ○ ○

SD Special register Decimal 0 to 2255 ○ ○

W*3*5 Link register Hexadeci
mal 000000 to 4AEBFF ○ ○

SW Link special register Hexadeci
mal 0000 to 7FFF ○ ○

R*3*4 File register Decimal 0 to 32767 ○ ○

ER*3*9 Extension file register(Block) Decimal

ER(R block)-(Device)
Notation example: ER255-100
• R block (decimal): 0 to 255
• Device (decimal): 0 to 32767

○ ○

ZR*3*5*7*

9 Extension file register Decimal 0 to 4849663 ○ ○

Z Index register Decimal 0 to 19 ○
○
(Not usable as bit 
data)

G*9 Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-G100
• Unit No. (hexadecimal): 00 to FF
• Device (decimal): 0 to 65535
For the module No., set the first 2 digits of 
the 3-digit number that represents the start 
I/O number of the buffer memory for the 
intelligent function module.

○ ○

Ww*8 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

Wr*8 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

LW Link register Hexadeci
mal 00000 to 1FFFF ○ ○

# Motion device Decimal 0 to 12287 ○ ○

U3E0 Multiple CPU high speed 
transmission memory Decimal

U3E0-G(Device)
Notation example: U3E0-10000
• Device (decimal): 10000 to 24335

○ ○

U3E1 Multiple CPU high speed 
transmission memory Decimal

U3E1-G(Device)
Notation example: U3E1-10000
• Device (decimal): 10000 to 24335

○ ○

U3E2 Multiple CPU high speed 
transmission memory Decimal

U3E2-(Device)
Notation example: U3E2-10000
• Device (decimal): 10000 to 24335

○ ○

U3E3 Multiple CPU high speed 
transmission memory Decimal

U3E3-(Device)
Notation example: U3E3-10000
• Device (decimal): 10000 to 24335

○ ○
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PA*2 Basic parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PB*2 Gain filter parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PC*2 Extension setting parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PD*2 I/O setting parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PO*2 Option unit parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PS*2 Special parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PU*2 Multi encoder parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PT*2 Positioning control parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PL*2 Linear servo motor/DD motor 
setting parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PN*2 Network setting parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

ST*2 Status display Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

PE*2 Extension setting No.2 parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1
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devices

Access using a 
client
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PF*2 Extension setting No.3 parameter Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

ALM*2

Alarm (current alarm J4A extend) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Alarm (alarm history J4A extend) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Alarm (alarm history J5G extend) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

POS*2 Point table (position) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

SPD*2 Point table (speed) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

ACT*2 Point table (acceleration time 
constant) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

DCT*2 Point table (deceleration time 
constant) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

DWL*2 Point table (dwell) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

AUX*2 Point table (auxiliary function) Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

MD*2 Machine diagnosis data Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

GFDS*2 Gear failure diagnosis data Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Device name
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.5 ■10 Virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/

M/DR/DSR, CRnD-700])
*3 Do not set a file register by GT Designer3 when executing multiple programs with the file of the file register set at [Use the 

same file name as the program.] by the PLC parameter of GX Developer.
Otherwise, read or write at GOT will be erroneous.

*4 Available for the file register of block No. switched with the RSET instruction.
*5 Available for the file register of block number of file name switched with the QDRSET instruction.
*6 Do not use the local device set in a MELSEC-Q system.

Doing so disables the correct monitoring.
*7 ZR1042432 to ZR4184063 cannot be used for GT SoftGOT2000.
*8 Not available to GT21.
*9 Available to GT21 when a Universal model QCPU is connected only.

ECCDS*

2
Encoder communication circuit 
diagnosis data Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

OTS*2 One-touch tuning data Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

DI*2 External input signal Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

DO*2 External output signal Decimal

➟12.3.5 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-Q/QS, 
Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

Device name
Device No. 
representa

tion
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■5 Setting virtual word devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (QD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (QD77GF).

Device name Device notation and setting range Notation example

PA

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PA(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

A32-PA1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PA(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

UFF-A32-PA1

[Master Module(CCIEF)]
PA(Device)
• Device (decimal): 1 to 44, 1001 to 1044

PA1

PB

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PB(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 92, 1001 to 1092

A32-PB1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 92, 1001 to 1092

UFF-A32-PB1

[Master Module(CCIEF)]
PB(Device)
• Device (decimal): 1 to 92, 1001 to 1092

PB1
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PC

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PC(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 90, 1001 to 1090

A32-PC1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PC(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 90, 1001 to 1090

UFF-A32-PC1

[Master Module(CCIEF)]
PC(Device)
• Device (decimal): 1 to 90, 1001 to 1090

PC1

PD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PD(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

A32-PD1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

UFF-A32-PD1

[Master Module(CCIEF)]
PD(Device)
• Device (decimal): 1 to 72, 1001 to 1072

PD1

PO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PO(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 2, 1001 to 1002

A32-PO1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 2, 1001 to 1002

UFF-A32-PO1

PS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PS(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

A32-PS1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

UFF-A32-PS1

PU

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PU(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

A32-PU1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PU(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 44, 1001 to 1044

UFF-A32-PU1

PT [Master Module(CCIEF)]
PT(Device)
• Device (decimal): 1 to 90, 1001 to 1090

PT1

PL

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PL(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

A32-PL1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PL(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 72, 1001 to 1072

UFF-A32-PL1

[Master Module(CCIEF)]
PL(Device)
• Device (decimal): 1 to 72, 1001 to 1072

PL1

PN [Master Module(CCIEF)]
PN(Device)
• Device (decimal): 1 to 32, 1001 to 1032

PN1

ST

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ST(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

A32-ST0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ST(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

UFF-A32-ST0

[Master Module(CCIEF)]
ST(Device)
• Device (decimal): 0 to 48

ST0

Device name Device notation and setting range Notation example
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PE

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PE(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 88, 1001 to 1088

A32-PE1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PE(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 88, 1001 to 1088

UFF-A32-PE1

[Master Module(CCIEF)]
PE(Device)
• Device (decimal): 1 to 88, 1001 to 1088

PE1

PF

[Motion Controller(SSCNET III/H)]
A(Axis No.)-PF(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

A32-PF1

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PF(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 99, 1001 to 1099

UFF-A32-PF1

[Master Module(CCIEF)]
PF(Device)
• Device (decimal): 1 to 99, 1001 to 1099

PF1

ALM

[Motion Controller(SSCNET III/H)]

A(Axis No.)-ALM(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

A32-ALM0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

UFF-A32-ALM0

[Master Module(CCIEF)]
ALM(Device)
• Device (decimal): 0 to 2, 11 to 59, 200 to 215, 220 to 235, 240 

to 255
ALM0

POS [Master Module(CCIEF)]
POS(Device)
• Device (decimal): 1 to 255, 1001 to 1255

POS1

SPD [Master Module(CCIEF)]
SPD(Device)
• Device (decimal): 1 to 255, 1001 to 1255

SPD1

ACT [Master Module(CCIEF)]
ACT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

ACT1

DCT [Master Module(CCIEF)]
DCT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DCT1

DWL [Master Module(CCIEF)]
DWL(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DWL1

AUX [Master Module(CCIEF)]
AUX(Device)
• Device (decimal): 1 to 255, 1001 to 1255

AUX1

MD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-MD(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 21

A32-MD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-MD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 21

UFF-A32-MD0

[Master Module(CCIEF)]
MD(Device)
• Device (decimal): 0 to 21

MD0

GFDS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-GFDS(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A32-GFDS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-GFDS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A32-GFDS0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from word devices ([MELSEC-Q/QS, Q17nD/M/NC/
DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following shows the availability of writing/reading data to/from word devices by device type.
The GOT can only read data from the device when the QS001CPU is used.
To write data to the consecutive devices of a Q172DR(CR750-Q), use the Q172DR(CR750-Q) with firmware version R6b 
or later.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

ECCDS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ECCDS(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

A32-ECCDS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ECCDS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A32-ECCDS0

OTS

[Motion Controller(SSCNET III/H)]
A(Axis No.)-OTS(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5, 3000

A32-OTS0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5, 3000

UFF-A32-OTS0

[Master Module(CCIEF)]
OTS(Device)
• Device (decimal): 0 to 5

OTS0

DI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-DI(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

A32-DI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A32-DI0

[Master Module(CCIEF)]
DI(Device)
• Device (decimal): 0 to 6

DI0

DO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-DO(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

A32-DO0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

UFF-A32-DO0

[Master Module(CCIEF)]
DO(Device)
• Device (decimal): 0 to 4

DO0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W R/W R/W

SD R/W R/W R/W R/W
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*1 Only reading is available for OTS0 to OTS5.

W R/W R/W R/W R/W

SW R/W R/W -/- R/W

R R/W R/W R/W R/W

ER R/W R/W R/W R/W

ZR R/W R/W R/W R/W

Z R/W R/W -/- -/-

G R/W R/W R/W R/W

Ww R/W R/W R/W R/W

Wr R/W R/W R/W R/W

LW R/W R/W R/W R/W

# R/W R/W -/- R/W

U3E0 R/W R/W R/W R/W

U3E1 R/W R/W R/W R/W

U3E2 R/W R/W R/W R/W

U3E3 R/W R/W R/W R/W

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PO R/W R/W -/- -/-

PS R/W R/W -/- -/-

PU R/W R/W -/- -/-

PT R/W R/W -/- -/-

PL R/W R/W -/- -/-

PN R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MD R/- R/- -/- -/-

GFDS R/- R/- -/- -/-

ECCDS R/- R/- -/- -/-

OTS*1 R/W R/W -/- -/-

DI R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data
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■7 Monitoring-supported double-word devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.5 ■9 Availability of writing/reading data to/from double-word devices ([MELSEC-Q/QS, Q17nD/M/NC/
DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.5 ■10 Virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/

M/DR/DSR, CRnD-700])
*3 Virtual inverter device

For the details, refer to the following.
➟12.3.5 ■12 Virtual inverter devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/

DSR, CRnD-700])
*4 If you specify LPr900 to LPr935, the following item is displayed in the device setting dialog.

• [Setting items (for calibration parameters)]: [Bias/gain value], [Analog input value]
Enclose the device number in parentheses when selecting [Analog input value].
Example 1) Notation when [Bias/gain value] is selected: LPr900
Example 2) Notation when [Analog input value] is selected: LPr(900)
When LPr900 or LPr901 (Calibration parameter) is specified, selecting [Bias/gain value] or [Analog input value] does not 
affect the monitoring target.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

ALD*2 Life diagnosis Decimal

➟12.3.5 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
Q/QS, Q17nD/M/NC/DR/DSR, CRnD-
700], [MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

TMI*2
Input signal for test operation (for 
test operation) Decimal

➟12.3.5 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
Q/QS, Q17nD/M/NC/DR/DSR, CRnD-
700], [MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

TMO*2 Forced output of signal pin (for test 
operation) Decimal

➟12.3.5 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
Q/QS, Q17nD/M/NC/DR/DSR, CRnD-
700], [MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

TMD*2 Set data (for test operation) Decimal

➟12.3.5 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
Q/QS, Q17nD/M/NC/DR/DSR, CRnD-
700], [MELSEC-Q, Q17nD/M/DR/DSR, 
CRnD-700])

× ×

AL*3 Faults history Decimal 0 to 899 × ×

LPr*3*4 Parameter (32-bit) Decimal 0 to 1500 × ×

OP*3 Operation parameter Decimal 0 to 5 × ×

PV*3 Current value monitor Decimal 1 to 143 × ×
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■8 Setting virtual double-word devices for servo amplifiers ([MELSEC-Q/QS, Q17nD/M/NC/DR/
DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

Item Description

[Motion Controller(SSCNET III/H)]
Select this item to connect the GOT through a Motion controller.
The following item is displayed.
• [Axis No.]: Set the axis number to be monitored.

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (QD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network or a Simple Motion module (QD77GF).

Device name Device notation and setting range Notation example

ALD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-ALD(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

A32-ALD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A32-ALD0

[Master Module(CCIEF)]
ALD(Device)
• Device (decimal): 0 to 1

ALD0

TMI

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMI(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

A32-TMI0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

UFF-A32-TMI0

[Master Module(CCIEF)]
TMI(Device)
• Device (decimal): 0 to 2

TMI0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■9 Availability of writing/reading data to/from double-word devices ([MELSEC-Q/QS, Q17nD/
M/NC/DR/DSR, CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following shows the availability of writing/reading data to/from double-word devices by device type.
The GOT can only read data from the device when the QS001CPU is used.
To write data to the consecutive devices of a Q172DR(CR750-Q), use the Q172DR(CR750-Q) with firmware version R6b 
or later.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■10 Virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], 
[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

TMO

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMO(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0

A32-TMO0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0

UFF-A32-TMO0

[Master Module(CCIEF)]
TMO(Device)
• Device (decimal): 0

TMO0

TMD

[Motion Controller(SSCNET III/H)]
A(Axis No.)-TMD(Device)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

A32-TMD0

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

UFF-A32-TMD0

[Master Module(CCIEF)]
TMD(Device)
• Device (decimal): 0 to 1, 3

TMD0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

AL -/- R/- -/- -/-

LPr -/- R/W -/- -/-

OP -/- R/W -/- -/-

PV -/- R/- -/- -/-

Virtual device name Reference

SP ➟12.3.2 ■10 (1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OM ➟12.3.2 ■10 (2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMB ➟12.3.2 ■10 (3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

OTI ➟12.3.2 ■10 (4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
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GFDI ➟12.3.2 ■10 (5) Gear failure diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

ECCDI ➟12.3.2 ■10 (6) Encoder communication circuit diagnosis instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

PA ➟12.3.2 ■10 (7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PB ➟12.3.2 ■10 (8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PC ➟12.3.2 ■10 (9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PD ➟12.3.2 ■10 (10) I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PO ➟12.3.2 ■10 (11) Option unit parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PS ➟12.3.2 ■10 (12) Special parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PU ➟12.3.2 ■10 (13) Multi encoder parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PT ➟12.3.2 ■10 (14) Positioning control parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PL ➟12.3.2 ■10 (15) Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PN ➟12.3.2 ■10 (16) Network setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ST ➟12.3.2 ■10 (18) Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PE ➟12.3.2 ■10 (19) Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PF ➟12.3.2 ■10 (20) Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ALM ➟12.3.2 ■10 (22) Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

POS ➟12.3.2 ■10 (24) Point table (position) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

SPD ➟12.3.2 ■10 (25) Point table (speed) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ACT ➟12.3.2 ■10 (26) Point table (acceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

DCT ➟12.3.2 ■10 (27) Point table (deceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

DWL ➟12.3.2 ■10 (28) Point table (dwell) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AUX ➟12.3.2 ■10 (29) Point table (auxiliary function) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

MD ➟12.3.2 ■10 (31) Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

GFDS ➟12.3.2 ■10 (32) Gear failure diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ECCDS ➟12.3.2 ■10 (33) Encoder communication circuit diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

OTS ➟12.3.2 ■10 (34) One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

DI
➟12.3.2 ■10 (35) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 

iQ-R, RnMT/RT, CR800-D])
12.3.2 ■10 (37) External input signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])

DO
➟12.3.2 ■10 (42) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 

iQ-R, RnMT/RT, CR800-D])
12.3.2 ■10 (44) External output signal in MR-J5(W)-□B(-RJ) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 

CR800-D])

ALD ➟12.3.2 ■10 (49) Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMI ➟12.3.2 ■10 (50) Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

TMO ➟12.3.2 ■10 (51) Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

Virtual device name Reference
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■11 Precautions for virtual servo amplifier devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, 
CRnD-700], [MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700])

For the precautions for virtual servo amplifier devices, refer to the following.
➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])

■12 Virtual inverter devices ([MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700], [MELSEC-Q, 
Q17nD/M/DR/DSR, CRnD-700])

The following shows the correspondence between the virtual devices used in the GOT and the inverter data.

TMD ➟12.3.2 ■10 (52) Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device name Reference

Virtual device name Reference

IOST ➟12.3.2 ■12 (1) I/O terminal monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

CMD ➟12.3.2 ■12 (2) Operation command ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AL ➟12.3.2 ■12 (5) Alarm history ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

LPr ➟12.3.2 ■12 (6) Parameter (32-bit) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OP ➟12.3.2 ■12 (7) Operation parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PV ➟12.3.2 ■12 (8) Current value monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
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12.3.6 [MELSEC QnA, MELDAS C6*]

■1 Monitoring-supported bit devices ([MELSEC QnA, MELDAS C6*])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.6 ■2 Availability of writing/reading data to/from bit devices ([MELSEC QnA, MELDAS C6*])
○: Available
×: Not available

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSEC QnA, MELDAS C6*])

➟■2 Availability of writing/reading data to/from bit devices ([MELSEC QnA, MELDAS C6*])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSEC QnA, MELDAS C6*])

➟■4 Availability of writing/reading data to/from word devices ([MELSEC QnA, MELDAS C6*])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name*3*4
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 3FFF 0000 to 1FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 3FFF 0000 to 1FFF ○ ○

B Link relay Hexadeci
mal 0000 to 7FFF 0000 to 7FFF ○ ○

M*2 Internal relay Decimal 0 to 32767 0 to 32767 ○ ○

L Latch relay Decimal 0 to 32767 0 to 32767 ○ ○

S Step relay Decimal 0 to 32767 0 to 32767 ○ ○

F Annunciator Decimal 0 to 32767 0 to 32767 ○ ○

TC*2 Timer coil Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

TT*2 Timer contact Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

CC*2 Counter coil Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

CT*2 Counter contact Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

SC*2 Retentive timer coil Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

SS*2 Retentive timer contact Decimal 0 to 32767 0 to 32767 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 0000 to 07FF 0000 to 07FF ○ ○

SM Special relay Decimal 0 to 2047 0 to 2047 ○ ○

RX Remote input Hexadeci
mal 000 to 7FF - ○ ○

RY Remote output Hexadeci
mal 000 to 7FF - ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Do not use the local device set in a MELSEC-Q system.

Doing so disables the correct monitoring.
*3 When monitoring MELDAS C6/C64, if a word device outside the range is set, the value will be indefinite.

If a bit device outside the range is set, the object may not be displayed or the set function may fail to operate.
Check the set device using the device list of GT Designer3.

*4 Devices used by the MELDAS C6/C64 system cannot be used.

■2 Availability of writing/reading data to/from bit devices ([MELSEC QnA, MELDAS C6*])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSEC QnA, MELDAS C6*])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.6 ■4 Availability of writing/reading data to/from word devices ([MELSEC QnA, MELDAS C6*])
○: Available
×: Not available

LB Link relay Hexadeci
mal 0000 to 7FFF - ○ ○

Device name*3*4
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

LB R/W -/- R/W R/W -/-

Device name*9*10
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

TN*6 Timer current value Decimal 0 to 32767 0 to 32767 ○ ○

CN*6 Counter current value Decimal 0 to 32767 0 to 32767 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Do not set a file register by GT Designer3 when executing multiple programs with the file of the file register set at [Use the 

same file name as the program.] by the PLC parameter of GX Developer.
(With exceptions of MELSEC-QnA)
Otherwise, read or write at GOT will be erroneous.

*3 Available for the file register of block No. switched with the RSET instruction.
*4 Available for the file register of block number of file name switched with the QDRSET instruction.
*5 Set a value within the range of registers that exist in the PLC
*6 Do not use the local device set in a MELSEC-Q system.

Doing so disables the correct monitoring.
*7 This cannot be monitored when the GOT multi-drop is connected.
*8 Only the intelligent function module on the station connected to GOT can be specified.

Set the buffer memory within the address range of the buffer memory existing in the intelligent function module.
*9 When monitoring MELDAS C6/C64, if a word device outside the range is set, the value will be indefinite.

If a bit device outside the range is set, the object may not be displayed or the set function may fail to operate.
Check the set device using the device list of GT Designer3.

*10 Devices used by the MELDAS C6/C64 system cannot be used.

SN*6 Retentive timer current value Decimal 0 to 32767 0 to 32767 ○ ○

D*6 Data register Decimal 0 to 32767 0 to 32767 ○ ○

SD Special register Decimal 0 to 2047 0 to 2047 ○ ○

W Link register Hexadeci
mal 0000 to 7FFF 0000 to 7FFF ○ ○

SW Link special register Hexadeci
mal 0000 to 07FF 0000 to 07FF ○ ○

R*2*3*5 File register Decimal 0 to 32767 0 to 32767 ○ ○

ER*2*7 Extension file register(Block) Decimal

ER(R block)-(Device)
Notation example: 
ER255-100
• R block (decimal): 0 to 

255
• Device (decimal): 0 to 

32767

- ○ ○

ZR*2*4*5*

7 Extension file register Decimal 0 to 1042431 - ○ ○

Z Index register Decimal 0 to 15 0 to 15 ○
○
(Not usable as bit 
data)

G*7*8 Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-
G100
• Unit No. (hexadecimal): 

00 to FF
• Device (decimal): 0 to 

65535

- ○ ○

Ww*7 Remote register Hexadeci
mal 0000 to 1FFF - ○ ○

Wr*7 Remote register Hexadeci
mal 0000 to 1FFF - ○ ○

LW Link register Hexadeci
mal 00000 to 1FFFF - ○ ○

Device name*9*10
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client
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■4 Availability of writing/reading data to/from word devices ([MELSEC QnA, MELDAS C6*])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W -/- R/W

SD R/W R/W -/- R/W

W R/W R/W -/- R/W

SW R/W R/W -/- R/W

R R/W R/W -/- R/W

ER R/W R/W -/- R/W

ZR R/W R/W -/- R/W

Z R/W R/W -/- -/-

G R/W R/W -/- R/W

Ww R/W R/W -/- R/W

Wr R/W R/W -/- R/W

LW R/W R/W -/- R/W
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12.3.7 [MELSEC-L]

■1 Monitoring-supported bit devices ([MELSEC-L])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.7 ■3 Availability of writing/reading data to/from bit devices ([MELSEC-L])
○: Available
×: Not available

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([MELSEC-L])

➟■2 Setting virtual bit devices for servo amplifiers ([MELSEC-L])

➟■3 Availability of writing/reading data to/from bit devices ([MELSEC-L])

Specifications of word devices

➟■4 Monitoring-supported word devices ([MELSEC-L])

➟■5 Setting virtual word devices for servo amplifiers ([MELSEC-L])

➟■6 Availability of writing/reading data to/from word devices ([MELSEC-L])

Specifications of double-word 
devices

➟■7 Monitoring-supported double-word devices ([MELSEC-L])

➟■8 Setting virtual double-word devices for servo amplifiers ([MELSEC-L])

➟■9 Availability of writing/reading data to/from double-word devices ([MELSEC-L])

Specifications of virtual servo 
amplifier devices

➟■10 Virtual servo amplifier devices ([MELSEC-L])

➟■11 Precautions for virtual servo amplifier devices ([MELSEC-L])

Specifications of virtual inverter 
devices ➟■12 Virtual inverter devices ([MELSEC-L])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 3FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 3FFF ○ ○

B Link relay Hexadeci
mal 0000 to EFFF ○ ○

M*4 Internal relay Decimal 0 to 61439 ○ ○

L Latch relay Decimal 0 to 32767 ○ ○

S Step relay Decimal 0 to 8191 ○ ○

F Annunciator Decimal 0 to 32767 ○ ○

TC*4 Timer coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

TT*4 Timer contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)

CC*4 Counter coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

CT*4 Counter contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 277



*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.7 ■10 Virtual servo amplifier devices ([MELSEC-L])

*3 Virtual inverter device
For the details, refer to the following.
➟12.3.7 ■12 Virtual inverter devices ([MELSEC-L])

*4 Do not use the local device set in a MELSEC-L system.
If used, the correct monitoring is disabled.
D32768 or later can be used for data register (D).

SC*4 Retentive timer coil Decimal 0 to 32767 ○
○
(Not usable as 
word data)

SS*4 Retentive timer contact Decimal 0 to 32767 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 0000 to 7FFF ○ ○

SM Special relay Decimal 0 to 2047 ○ ○

RX Remote input Hexadeci
mal 0000 to 3FFF ○ ○

RY Remote output Hexadeci
mal 0000 to 3FFF ○ ○

SP*2 Servo amplifier request Decimal ➟12.3.7 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-L])

× ×

OM*2 Operation mode selection Decimal ➟12.3.7 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-L])

× ×

TMB*2 Instruction demand (for test 
operation) Decimal ➟12.3.7 ■2 Setting virtual bit devices for 

servo amplifiers ([MELSEC-L])
× ×

OTI*2 One-touch tuning instruction Decimal ➟12.3.7 ■2 Setting virtual bit devices for 
servo amplifiers ([MELSEC-L])

× ×

IOST*3 I/O terminal monitor Decimal 0 to 127 × ×

CMD*3 Operation command Decimal 0 to 63 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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■2 Setting virtual bit devices for servo amplifiers ([MELSEC-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

Item Description

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (LD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network.

Device name Device notation and setting range Notation example

SP

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-SP(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A32-SP0

[Master Module(CCIEF)]
SP(Device)
• Device (decimal): 0 to 6

SP0

OM

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2, 4 to 5

UFF-A32-OM0

[Master Module(CCIEF)]
OM(Device)
• Device (decimal): 0 to 2, 4 to 5

OM0

TMB

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 6

UFF-A32-TMB1

[Master Module(CCIEF)]
TMB(Device)
• Device (decimal): 1 to 6

TMB1

OTI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 5

UFF-A32-OTI0

[Master Module(CCIEF)]
OTI(Device)
• Device (decimal): 0 to 5

OTI0
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■3 Availability of writing/reading data to/from bit devices ([MELSEC-L])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([MELSEC-L])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.7 ■6 Availability of writing/reading data to/from word devices ([MELSEC-L])
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

S R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

IOST R/- -/- -/- -/- -/-

CMD -/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN*6 Timer current value Decimal 0 to 32767 ○ ○

CN*6 Counter current value Decimal 0 to 32767 ○ ○

SN*6 Retentive timer current value Decimal 0 to 32767 ○ ○

D*6 Data register Decimal 0 to 421887 ○ ○

SD Special register Decimal 0 to 2047 ○ ○

W Link register Hexadeci
mal 00000 to 66FFF ○ ○

SW Link special register Hexadeci
mal 0000 to 7FFF ○ ○
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R*3*4 File register Decimal 0 to 32767 ○ ○

ZR*3*5 Extension file register Decimal 0 to 393215 ○ ○

Z Index register Decimal 0 to 19 ○
○
(Not usable as bit 
data)

G Buffer memory (Intelligent function 
module) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-G100
• Unit No.(hexadecimal): 00 to FF
• Device (decimal): 0 to 65535
For the unit No., set the first 2 digits of the 
3-digit number that represents the start I/O 
number of the buffer memory for the 
intelligent function module.

○ ○

Ww*7 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

Wr*7 Remote register Hexadeci
mal 0000 to 1FFF ○ ○

PA*2 Basic parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PB*2 Gain filter parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PC*2 Extension setting parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PD*2 I/O setting parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PT*2 Positioning control parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PL*2 Linear servo motor/DD motor 
setting parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC-L])
× ×

PN*2 Network setting parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

ST*2*7 Status display Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PE*2 Extension setting No.2 parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

PF*2 Extension setting No.3 parameter Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

ALM*2*7 Alarm (current alarm J4A extend) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

ALM*2*7 Alarm (alarm history J4A extend) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

POS*2 Point table (position) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

SPD*2 Point table (speed) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

ACT*2 Point table (acceleration time 
constant) Decimal ➟12.3.7 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC-L])
× ×

DCT*2 Point table (deceleration time 
constant) Decimal ➟12.3.7 ■5 Setting virtual word devices for 

servo amplifiers ([MELSEC-L])
× ×

DWL*2 Point table (dwell) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

AUX*2 Point table (auxiliary function) Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.7 ■10 Virtual servo amplifier devices ([MELSEC-L])

*3 Do not set a file register by GT Designer3 when executing multiple programs with the file of the file register set at [Use the 
same file name as the program.] by the PLC parameter of GX Developer.
Otherwise, read or write at GOT will be erroneous.

*4 Available for the file register of block No. switched with the RSET instruction.
*5 Available for the file register of block number of file name switched with the QDRSET instruction.
*6 Do not use the local device set in a MELSEC-L system.

If used, the correct monitoring is disabled.
D32768 or later can be used for data register (D).

*7 This cannot be monitored when the GOT multi-drop is connected.

■5 Setting virtual word devices for servo amplifiers ([MELSEC-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

MD*2*7 Machine diagnosis data Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

OTS*2*7 One-touch tuning data Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

DI*2 External input signal Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

DO*2*7 External output signal Decimal ➟12.3.7 ■5 Setting virtual word devices for 
servo amplifiers ([MELSEC-L])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Item Description

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (LD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network.
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The following shows the notation and setting range of virtual devices.

Device name Device notation and setting range Notation example

PA

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PA(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 32, 1001 to 1032

UFF-A32-PA1

[Master Module(CCIEF)]
PA(Device)
• Device (decimal): 1 to 32, 1001 to 1032

PA1

PB

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PB(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A32-PB1

[Master Module(CCIEF)]
PB(Device)
• Device (decimal): 1 to 64, 1001 to 1064

PB1

PC

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PC(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 80, 1001 to 1080

UFF-A32-PC1

[Master Module(CCIEF)]
PC(Device)
• Device (decimal): 1 to 80, 1001 to 1080

PC1

PD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 48, 1001 to 1048

UFF-A32-PD1

[Master Module(CCIEF)]
PD(Device)
• Device (decimal): 1 to 48, 1001 to 1048

PD1

PT [Master Module(CCIEF)]
PT(Device)
• Device (decimal): 1 to 80, 1001 to 1080

PT1

PL

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PL(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 48, 1001 to 1048

UFF-A32-PL1

[Master Module(CCIEF)]
PL(Device)
• Device (decimal): 1 to 48, 1001 to 1048

PL1

PN [Master Module(CCIEF)]
PN(Device)
• Device (decimal): 1 to 32, 1001 to 1032

PN1

ST

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ST(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 48

UFF-A32-ST0

[Master Module(CCIEF)]
ST(Device)
• Device (decimal): 0 to 48

ST0

PE

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PE(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A32-PE1

[Master Module(CCIEF)]
PE(Device)
• Device (decimal): 1 to 64, 1001 to 1064

PE1

PF

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-PF(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 1 to 64, 1001 to 1064

UFF-A32-PF1

[Master Module(CCIEF)]
PF(Device)
• Device (decimal): 1 to 64, 1001 to 1064

PF1

ALM

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALM(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 11 to 59, 200 to 215, 220 to 235, 240 

to 255

UFF-A32-ALM0

[Master Module(CCIEF)]
ALM(Device)
• Device (decimal): 0 to 1, 11 to 59, 200 to 215, 220 to 235, 240 

to 255
ALM0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from word devices ([MELSEC-L])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

POS [Master Module(CCIEF)]
POS(Device)
• Device (decimal): 1 to 255, 1001 to 1255

POS1

SPD [Master Module(CCIEF)]
SPD(Device)
• Device (decimal): 1 to 255, 1001 to 1255

SPD1

ACT [Master Module(CCIEF)]
ACT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

ACT1

DCT [Master Module(CCIEF)]
DCT(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DCT1

DWL [Master Module(CCIEF)]
DWL(Device)
• Device (decimal): 1 to 255, 1001 to 1255

DWL1

AUX [Master Module(CCIEF)]
AUX(Device)
• Device (decimal): 1 to 255, 1001 to 1255

AUX1

MD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-MD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 18

UFF-A32-MD0

[Master Module(CCIEF)]
MD(Device)
• Device (decimal): 0 to 18

MD0

OTS

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-OTS(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 3

UFF-A32-OTS0

[Master Module(CCIEF)]
OTS(Device)
• Device (decimal): 0 to 3

OTS0

DI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 6

UFF-A32-DI0

[Master Module(CCIEF)]
DI(Device)
• Device (decimal): 0 to 6

DI0

DO

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-DO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 4

UFF-A32-DO0

[Master Module(CCIEF)]
DO(Device)
• Device (decimal): 0 to 4

DO0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W R/W R/W

SD R/W R/W R/W R/W

W R/W R/W R/W R/W
12 - 284 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
■7 Monitoring-supported double-word devices ([MELSEC-L])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.7 ■9 Availability of writing/reading data to/from double-word devices ([MELSEC-L])
○: Available
×: Not available

SW R/W R/W -/- R/W

R R/W R/W R/W R/W

ZR R/W R/W R/W R/W

Z R/W R/W -/- -/-

G R/W R/W R/W R/W

Ww R/W R/W R/W R/W

Wr R/W R/W R/W R/W

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PT R/W R/W -/- -/-

PL R/W R/W -/- -/-

PN R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MD R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

ALD*2 Life diagnosis Decimal
➟12.3.7 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC-
L])

× ×

TMI*2
Input signal for test operation (for 
test operation) Decimal

➟12.3.7 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
L])

× ×

TMO*2 Forced output of signal pin (for test 
operation) Decimal

➟12.3.7 ■8 Setting virtual double-word 
devices for servo amplifiers ([MELSEC-
L])

× ×

TMD*2 Set data (for test operation) Decimal
➟12.3.7 ■8 Setting virtual double-word 

devices for servo amplifiers ([MELSEC-
L])

× ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Virtual servo amplifier device

For the details, refer to the following.
➟12.3.7 ■10 Virtual servo amplifier devices ([MELSEC-L])

*3 Virtual inverter device
For the details, refer to the following.
➟12.3.7 ■12 Virtual inverter devices ([MELSEC-L])

■8 Setting virtual double-word devices for servo amplifiers ([MELSEC-L])
For virtual servo amplifier devices, the notation differs according to the connection type between the GOT and the servo 
amplifier.
Select one of the following according to the control type in the device setting dialog.

The following shows the notation and setting range of virtual devices.

AL*3 Faults history Decimal 0 to 899 × ×

LPr*3 Parameter (32-bit) Decimal 0 to 1500 × ×

OP*3 Operation parameter Decimal 0 to 5 × ×

PV*3 Current value monitor Decimal 1 to 143 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Item Description

[Simple Motion(SSCNET III/H)]

Select this item to connect the GOT through a Simple Motion module (LD77MS).
The following item is displayed.
• [Unit No.]: Set the first 2 digits of the 3-digit number that represents the start I/O 

number of the Simple Motion module.
• [Axis No.]: Set the axis number to be monitored.

[Master Module(CCIEF)] Select this item to connect the GOT through the master station on the CC-Link IE Field 
Network.

Device name Device notation and setting range Notation example

ALD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-ALD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1

UFF-A32-ALD0

[Master Module(CCIEF)]
ALD(Device)
• Device (decimal): 0 to 1

ALD0

TMI

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMI(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 2

UFF-A32-TMI0

[Master Module(CCIEF)]
TMI(Device)
• Device (decimal): 0 to 2

TMI0
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For indirect specification of a module or axis number, refer to the following.
➟12.3.2 ■2 (1) Indirect specification of a module number ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 

[MELSEC iQ-R, RnMT/RT, CR800-D])
　 12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■9 Availability of writing/reading data to/from double-word devices ([MELSEC-L])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■10 Virtual servo amplifier devices ([MELSEC-L])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

TMO

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMO(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0

UFF-A32-TMO0

[Master Module(CCIEF)]
TMO(Device)
• Device (decimal): 0

TMO0

TMD

[Simple Motion(SSCNET III/H)]

U(Unit No.)-A(Axis No.)-TMD(Device)
• Unit No. (hexadecimal): 00 to FF (direct), 100 to 10F (indirect)
• Axis No. (decimal): 1 to 32 (direct), 100 to 115 (indirect)
• Device (decimal): 0 to 1, 3

UFF-A32-TMD0

[Master Module(CCIEF)]
TMD(Device)
• Device (decimal): 0 to 1, 3

TMD0

Device name Device notation and setting range Notation example

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

AL -/- R/- -/- -/-

LPr -/- R/W -/- -/-

OP -/- R/W -/- -/-

PV -/- R/- -/- -/-

Virtual device name Reference

SP ➟12.3.2 ■10 (1) Servo amplifier request ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

OM ➟12.3.2 ■10 (2) Operation mode selection ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

TMB ➟12.3.2 ■10 (3) Instruction demand (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

OTI ➟12.3.2 ■10 (4) One-touch tuning instruction ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PA ➟12.3.2 ■10 (7) Basic parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PB ➟12.3.2 ■10 (8) Gain filter parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PC ➟12.3.2 ■10 (9) Extension setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

PD ➟12.3.2 ■10 (10) I/O setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PT ➟12.3.2 ■10 (14) Positioning control parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])
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■11 Precautions for virtual servo amplifier devices ([MELSEC-L])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

■12 Virtual inverter devices ([MELSEC-L])
The following shows the correspondence between the virtual devices used in the GOT and the inverter data.

PL ➟12.3.2 ■10 (15) Motor extension parameter, linear servo motor/DD motor setting parameter ([MELSEC iQ-R, RnMT/NC/
RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PN ➟12.3.2 ■10 (16) Network setting parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

ST ➟12.3.2 ■10 (18) Status display ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PE ➟12.3.2 ■10 (19) Extension setting No.2 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

PF ➟12.3.2 ■10 (20) Extension setting No.3 parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/
RT, CR800-D])

ALM ➟12.3.2 ■10 (22) Alarm ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

POS ➟12.3.2 ■10 (24) Point table (position) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

SPD ➟12.3.2 ■10 (25) Point table (speed) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

ACT ➟12.3.2 ■10 (26) Point table (acceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

DCT ➟12.3.2 ■10 (27) Point table (deceleration time constant) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, 
RnMT/RT, CR800-D])

DWL ➟12.3.2 ■10 (28) Point table (dwell) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AUX ➟12.3.2 ■10 (29) Point table (auxiliary function) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

MD ➟12.3.2 ■10 (31) Machine diagnosis data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

OTS ➟12.3.2 ■10 (34) One-touch tuning data ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-
D])

DI ➟12.3.2 ■10 (35) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

DO ➟12.3.2 ■10 (42) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

ALD ➟12.3.2 ■10 (49) Life Diagnosis ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

TMI ➟12.3.2 ■10 (50) Input signal for test operation (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC 
iQ-R, RnMT/RT, CR800-D])

TMO ➟12.3.2 ■10 (51) Forced output of signal pin (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-
R, RnMT/RT, CR800-D])

TMD ➟12.3.2 ■10 (52) Set data (for test operation) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, 
CR800-D])

Virtual device name Reference

Virtual device name Reference

IOST ➟12.3.2 ■12 (1) I/O terminal monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

CMD ➟12.3.2 ■12 (2) Operation command ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

AL ➟12.3.2 ■12 (5) Alarm history ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

LPr ➟12.3.2 ■12 (6) Parameter (32-bit) ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

OP ➟12.3.2 ■12 (7) Operation parameter ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

PV ➟12.3.2 ■12 (8) Current value monitor ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])
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12.3.8 [MELSEC-A]

■1 Monitoring-supported bit devices ([MELSEC-A])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.8 ■2 Availability of writing/reading data to/from bit devices ([MELSEC-A])
For monitoring-supported bit devices in the multi-drop connection, refer to the range for GT21 and GS21 in the following 
table.
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 If the special internal relay (M) is converted to the word device, treat 9000 of the device No. as 0 and set in multiples of 16.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSEC-A])

➟■2 Availability of writing/reading data to/from bit devices ([MELSEC-A])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSEC-A])

➟■4 Availability of writing/reading data to/from word devices ([MELSEC-A])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

X Input relay Hexadeci
mal 0000 to 1FFF 0000 to 1FFF ○ ○

Y Output relay Hexadeci
mal 0000 to 1FFF 0000 to 1FFF ○ ○

B Link relay Hexadeci
mal 0000 to 7FFF 0000 to 1FFF ○ ○

M Internal relay Decimal
0 to 8999
9256 to 32767

0 to 8999 ○ ○

M*2 Special internal relay Decimal 9000 to 9255 9000 to 9255 ○ ○

L Latch relay Decimal 0 to 32767 0 to 8191 ○ ○

F Annunciator Decimal 0 to 32767 0 to 2047 ○ ○

TC Timer coil Decimal 0 to 32767 0 to 2047 ○
○
(Not usable as 
word data)

TT Timer contact Decimal 0 to 32767 0 to 2047 ○
○
(Not usable as 
word data)

CC Counter coil Decimal 0 to 32767 0 to 1023 ○
○
(Not usable as 
word data)

CT Counter contact Decimal 0 to 32767 0 to 1023 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 0000 to 07FF - ○ ○

RX Remote input Hexadeci
mal 000 to 7FF - ○ ○

RY Remote output Hexadeci
mal 000 to 7FF - ○ ○

LB Link relay Hexadeci
mal 0000 to 1FFF - ○ ○
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 289



Example) M9000, M9016, M9240

■2 Availability of writing/reading data to/from bit devices ([MELSEC-A])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSEC-A])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.8 ■4 Availability of writing/reading data to/from word devices ([MELSEC-A])
For monitoring-supported word devices in the multi-drop connection, refer to the range for GT21 and GS21 in the 
following table.
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

LB R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

TN Timer current value Decimal 0 to 32767 0 to 2047 ○ ○

CN Counter current value Decimal 0 to 32767 0 to 1023 ○ ○

D Data register Decimal
0 to 8999
9256 to 32767

0 to 8999 ○ ○

D Special data register Decimal 9000 to 9255 9000 to 9255 ○ ○

W Link register Hexadeci
mal 0000 to 7FFF 0000 to 1FFF ○ ○

SW Link special register Hexadeci
mal 0000 to 07FF - ○ ○

R File register Decimal 0 to 32767 0 to 8191 ○ ○

ER Extension file register(Block) Decimal

ER(R block)-(Device)
Notation example: 
ER255-100
• R block (decimal): 0 to 

255
• Device (decimal): 0 to 

8191

- ○ ○

ZR Extension file register Decimal 0 to 1042431 - ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Only the intelligent function module on the station connected to GOT can be specified.

Set the buffer memory within the address range of the buffer memory existing in the intelligent function module.

■4 Availability of writing/reading data to/from word devices ([MELSEC-A])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Z Index register Decimal 0 to 6 0 to 6 ○
○
(Not usable as bit 
data)

V Index register Decimal 0 to 6 0 to 6 ○
○
(Not usable as bit 
data)

BM*2 Buffer memory (Intelligent function 
module) Decimal

GM(R block)-(Device)
Notation example: 
BMFF-100
• BM start No. 

(hexadecimal): 00 to FF
• Device (decimal): 0 to 

32767
For the BM start No., set 
the first 2 digits of the 3-
digit number that 
represents the start I/O 
number of the buffer 
memory for the intelligent 
function module.

- ○
○
(Not usable as bit 
data)

Ww Remote register Hexadeci
mal 000 to 7FF - ○ ○

Wr Remote register Hexadeci
mal 000 to 7FF - ○ ○

LW Link register Hexadeci
mal 0000 to 1FFF - ○ ○

A Accumulator Decimal 0 to 1 0 to 1 ○ ○

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, GT 
SoftGOT2000, and 

GS25

GT21 and 
GS21

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- R/W

CN R/W R/W -/- R/W

D R/W R/W -/- R/W

W R/W R/W -/- R/W

SW R/W R/W -/- R/W

R R/W R/W -/- R/W

ER*1 R/W R/W -/- R/W

ZR R/W R/W -/- R/W

Z*2 R/W R/W -/- -/-

V*2 R/W R/W -/- R/W

BM R/W R/W -/- -/-

Ww R/W R/W -/- R/W

Wr R/W R/W -/- R/W

LW R/W R/W -/- R/W
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*1 In the computer link connection, the bit specification writing of the word device to the ER29-0 (block 29 of the extension file 
register) or later of A3ACPU, A3UCPU, A4UCPU is not available.
When the bit specification writing of the word device is required, use the range of block No. 0 to 28.

*2 In the computer link connection, writing to the index register (such as the touch switch function and numerical input function) 
is not available.

*3 In the multi-drop connection (computer link connection between the CPU and the serial multi-drop connection unit), reading/
writing data from/to an accumulator is not available.

A*3 R/W R/W -/- R/W

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data
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12.3.9 [MELSEC-FX]

■1 Monitoring-supported bit devices ([MELSEC-FX])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.9 ■2 Availability of writing/reading data to/from bit devices ([MELSEC-FX])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSEC-FX])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSEC-FX])

➟■2 Availability of writing/reading data to/from bit devices ([MELSEC-FX])

Specifications of word devices

➟■3 Monitoring-supported word devices ([MELSEC-FX])

➟■4 Setting the buffer memory device ([MELSEC-FX])

➟■5 Availability of writing/reading data to/from word devices ([MELSEC-FX])

Protection with a keyword ➟■6 Protection using a keyword ([MELSEC-FX])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Octal 0000 to 0377 ○ ○

Y Output relay Octal 0000 to 0377 ○ ○

M Auxiliary relay Decimal 0 to 7679 ○ ○

M Special aux relay Decimal 8000 to 8511 ○ ○

S State Decimal 0 to 4095 ○ ○

T Timer contact Decimal 0 to 511 ○
○
(Not usable as 
word data)

C Counter contact Decimal 0 to 255 ○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

S R/W -/- R/W R/W -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-
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■3 Monitoring-supported word devices ([MELSEC-FX])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.9 ■5 Availability of writing/reading data to/from word devices ([MELSEC-FX])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Only 16-bit (1-word) specification is possible.
*3 For CS0 to CS199 and C0 to C199, only 16-bit (1-word) specification is allowed.

For CS200 to CS255 and C200 to C255, only 32-bit (2-word) specification is allowed.
*4 The setting values of the timer and counter, which are not used for the program, cannot be monitored.

If monitoring is executed, a reading error occurs.
*5 Usable only for special blocks or special units compatible with FX1N, FX1NC, FX2N, FX2NC, FX3G, FX3GC, FX3U, or 

FX3UC.
(Except FX0N-3A, FX2N-2AD, and FX2N-2DA)

*6 GT SoftGOT2000 and GT Simulator3 cannot monitor the set values.

■4 Setting the buffer memory device ([MELSEC-FX])
(1) Buffer memory format ([MELSEC-FX])

The following shows the format in the setting dialog of objects or others.

Example) Unit No.: 1, MASK: 6, Device: 100

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T Timer current value Decimal 0 to 511 ○ ○

C*3 Counter current value Decimal 0 to 255 ○ ○

D Data register Decimal 0 to 7999 ○ ○

D Special data register Decimal 8000 to 8511 ○ ○

R Extension register Decimal 0 to 32767 ○ ○

Z Index register Decimal 0 to 7 ○
○
(Not usable as bit 
data)

V Index register Decimal 0 to 7 ○
○
(Not usable as bit 
data)

BM*5 Buffer memory Decimal ➟12.3.9 ■4 Setting the buffer memory 
device ([MELSEC-FX])

○ ○

TS*2*4*6 Timer set value Decimal 0 to 511 ○ ○

CS*3*4*6 Counter set value Decimal 0 to 255 ○ ○

Device name Format

Buffer memory BM(Unit No.)/(MASK)-(Device)
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The buffer memory format includes the following elements.

(2) MASK setting ([MELSEC-FX])
The following shows the processing corresponding to each setting value for MASK.

Item Description

MASK

Setting range 0 to 6

Device No. 
representation Decimal

Explanation

Set this item when only specific bit of the buffer memory is monitored or written.
When this item is 0, /(MASK) is unnecessary.
For the processing corresponding to each setting value, refer to the following.

➟12.3.9 ■4 (2) MASK setting ([MELSEC-FX])

Unit No.

Setting range 0 to 7 (direct), 100 to 115 (indirect)

Device No. 
representation Decimal

Explanation

Set the unit No. of the special block or special unit to be monitored or written.
The unit No. (No.0 to No.7) is assigned to the unit or block in order of distance from the 
main unit.
For the details of the unit No., refer to the following.

➟User's Manual (Hardware) of the MELSEC-FX used
For indirect specification of a unit No., refer to the following.

➟12.3.9 ■4 (3) Indirect specification of a unit No. ([MELSEC-FX])

Device

Setting range 0 to 32767

Device No. 
representation Decimal

Explanation Buffer memory

MASK
Processing

Data type: 16-bit Data type: 32-bit

0 The buffer memory value is monitored or written.

1

Only b0 to b3 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 1: Monitored 
value = 0001H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 1: BM0 = 0001H

Only b0 to b3 and b16 to b19 of the buffer memory is monitored 
or written.
Example) Monitoring BM0 = 87654321H with MASK 1: 
Monitored value = 00050001H

Example) Writing the input value (87654321H) to BM0 = 
00000000H with MASK 1: BM0 = 00050001H

BM0

Monitored value

H4 3 2 1

0 0 0 1 H

BM0
(Before writing)

(After writing)
BM0

Input value H4 3 2 1

0 0 0 0 H

0 0 0 1 H

HBM0 8 7 6 5 4 3 2 1

0 0 0 5 0 0 0 1 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 0 0 0 5 0 0 0 1 H

(Before writing)

(After writing)
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2

Only b4 to b7 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 2: Monitored 
value = 0002H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 2: BM0 = 0010H

Only b4 to b7 and b20 to b23 of the buffer memory is monitored 
or written.
Example) Monitoring BM0 = 87654321H with MASK 2: 
Monitored value = 00060002H

Example) Writing the input value (87654321H) to BM0 = 
00000000H with MASK 2: BM0 = 00500010H

3

Only b8 to b11 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 3: Monitored 
value = 0003H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 3: BM0 = 0100H

Only b8 to b11 and b28 to b31 of the buffer memory is 
monitored or written.
Example) Monitoring BM0 = 87654321H with MASK 3: 
Monitored value = 00070003H

Example) Writing the input value (87654321H) to BM0 = 
00000000H with MASK 3: BM0 = 00050001H

4

Only b12 to b15 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 4: Monitored 
value = 0004H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 4: BM0 = 1000H

Only b12 to b15 and b28 to b31 of the buffer memory is 
monitored or written.
Example) Monitoring BM0 = 87654321H with MASK 4: 
Monitored value = 00080004H

Example) Writing the input value (87654321H) to 
BM0=00000000H with MASK 4: BM0=50001000H

MASK
Processing

Data type: 16-bit Data type: 32-bit

BM0

Monitored value

H4 3 2 1

0 0 0 2 H

BM0
(Before writing)

(After writing)
BM0

Input value
H4 3 2 1

0 0 0 0 H

0 0 1 0 H

HBM0 8 7 6 5 4 3 2 1

0 0 0 6 0 0 0 2 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 0 0 5 0 0 0 1 0 H

(Before writing)

(After writing)

BM0

Monitored value

H4 3 2 1

0 0 0 3 H

BM0
(Before writing)

(After writing)
BM0

Input value H4 3 2 1

0 0 0 0 H

0 1 0 0 H

HBM0 8 7 6 5 4 3 2 1

0 0 0 7 0 0 0 3 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 0 5 0 0 0 1 0 0 H

(Before writing)

(After writing)

BM0

Monitored value

H4 3 2 1

0 0 0 4 H

BM0
(Before writing)

(After writing)
BM0

Input value H4 3 2 1

0 0 0 0 H

1 0 0 0 H

HBM0 8 7 6 5 4 3 2 1

0 0 0 8 0 0 0 4 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 5 0 0 0 1 0 0 0 H

(Before writing)

(After writing)
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(3) Indirect specification of a unit No. ([MELSEC-FX])
When you specify any of 100 to 115 for the unit No., the value of the corresponding GOT internal register (GD10 to GD25) 
is used as the unit number of a special block or special unit.
In the multi-drop connection, indirect specification of a unit No. not available.
The following shows the correspondence between unit Nos. and GOT data registers.

(4) Precautions for using the buffer memory
• When the special block or special unit is turned off, the data in the buffer memory, except the data in some keep areas, 

are initialized.
• When the GOT monitors the buffer memory, the scan time of the PLC may momentarily increase.
• Specify 16-bit data for a 16-bit buffer memory, and specify 32-bit data for a 32-bit buffer memory.

If 16-bit data is specified for a 32-bit buffer memory, monitoring/writing may not be performed properly.

5

Only b0 to b7 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 5: Monitored 
value = 0021H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 5: BM0 = 0021H

Only b0 to b7 and b16 to b13 of the buffer memory is monitored 
or written.
Example) Monitoring BM0 = 87654321H with MASK 5: 
Monitored value = 00650021H

Example) Writing the input value (87654321H) to 
BM0=00000000H with MASK 5: BM0=00650021H

6

Only b8 to b15 of the buffer memory is monitored or written.
Example) Monitoring BM0 = 4321H with MASK 6: Monitored 
value = 0043H

Example) Writing the input value (4321H) to BM0 = 0000H with 
MASK 6: BM0 = 2100H

Only b8 to b15 and b24 to b31 of the buffer memory is 
monitored or written.
Example) Monitoring BM0 = 87654321H with MASK 6: 
Monitored value = 00870043H

Example) Writing the input value (87654321H) to 
BM0=00000000H with MASK 6: BM0=65002100H

MASK
Processing

Data type: 16-bit Data type: 32-bit

BM0

Monitored value

H4 3 2 1

0 0 2 1 H

BM0
(Before writing)

(After writing)
BM0

Input value H4 3 2 1

0 0 0 0 H

0 0 2 1 H

HBM0 8 7 6 5 4 3 2 1

0 0 6 5 0 0 2 1 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 0 0 6 5 0 0 2 1 H

(Before writing)

(After writing)

BM0

Monitored value

H4 3 2 1

0 0 4 3 H

BM0
(Before writing)

(After writing)
BM0

Input value H4 3 2 1

0 0 0 0 H

2 1 0 0 H

HBM0 8 7 6 5 4 3 2 1

0 0 8 7 0 0 4 3 HMonitored value

H

BM0

8 7 6 5 4 3 2 1

0 0 0 0 0 0 0 0 H

Input value

BM0 6 5 0 0 2 1 0 0 H

(Before writing)

(After writing)

Unit No. GOT data registers (GD) Setting range

100 GD10

[0] to [7]
Setting a value outside the above range causes a device range error.
If a non-existent unit No. is set, a communication timeout error occurs.

101 GD11

: :

114 GD24

115 GD25
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• For the data size of each buffer memory, refer to the following.
➟User's Manual of the special block or special unit

• When reading/writing data from/to the special block or special unit is performed by interrupting the sequence program, 
monitoring the buffer memory from the GOT or writing data from the GOT to the buffer memory may not be performed 
properly.

■5 Availability of writing/reading data to/from word devices ([MELSEC-FX])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 When executing the touch switch function that has been set during the bit specification of the word device, do not write any 
data to the word device through the sequence program.

■6 Protection using a keyword ([MELSEC-FX])
(1) How to select a protection level by using a keyword

You can set a protection level for equipment that is allowed to access the FX PLC online, and three protection levels are 
selectable.
When performing monitoring or changing settings with any on-line equipment is required, specify a keyword with referring 
to the following.

(2) Monitoring availability at each keyword protection level
The following shows the device monitoring availability at each keyword protection level.

*1 When the value of the T or C device is set indirectly, changing the device is available.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

T R/W R/W -/- R/W

C R/W R/W -/- R/W

D R/W R/W -/- R/W

R R/W R/W -/- R/W

Z R/W R/W -/- R/W

V R/W -/- -/- R/W

BM R/W R/W -/- R/W

TS R/W -/- -/- -/-

CS R/W R/W -/- -/-

Registered keyword Description

When registering a keyword only

Select a protection level by specifying an applicable letter for the initial letter in a keyword.
All operations prohibited: Specify a keyword beginning with A, D to F, or 0 to 9.
Incorrect write/read prohibited: Specify a keyword beginning with B.
Incorrect write prohibited: Specify a keyword beginning with C.

When registering a keyword and the second keyword Select a protection level in [Registration condition].

Item

When registering a keyword only When registering a keyword and the 
second keyword Keyword not 

registered or 
protection canceledAll 

operations 
prohibited

Incorrect 
write/read 
prohibited

Write 
prohibited

All online 
operations 
prohibited

Read/write 
prohibited

Write 
prohibited

Monitoring devices ○ ○ ○ × ○ ○ ○

Changing 
devices

Value of T or C, and 
file registers
(D1000 and the 
following)

×*1 ×*1 ×*1 × ○ ○ ○

Other than the 
above ○ ○ ○ × ○ ○ ○
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(3) Difference between all online operations prohibition and all operations prohibition
When all online operations are prohibited, the programming tool and GOT cannot display devices and input data.
When all operations are prohibited, you cannot perform all operations with the programming tool, but the GOT can display 
devices and input data.
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12.3.10 [MELSEC-WS]

■1 Monitoring-supported bit devices ([MELSEC-WS])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.10 ■2 Availability of writing/reading data to/from bit devices ([MELSEC-WS])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSEC-WS])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSEC-WS])

➟■2 Availability of writing/reading data to/from bit devices ([MELSEC-WS])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSEC-WS])

➟■4 Availability of writing/reading data to/from word devices ([MELSEC-WS])

Engineering software for 
MELSEC-WS and device 
representation of GT Designer3

➟■5 Engineering software for MELSEC-WS and device representation of GT Designer3 ([MELSEC-WS])

Offset specifications ➟■6 Offset specification ([MELSEC-WS])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input Decimal

I(Module No.).(Input position)
Notation example: I12.8
• Module No. (decimal): 1 to 12
• Input position (decimal): 1 to 8

× ×

Q Output Decimal

Q(Module No.).(Output position)
Notation example: Q12.8
• Module No. (decimal): 1 to 12
• Output position (decimal): 1 to 8

× ×

LI Logic input Decimal

LI(Byte No.).(Bit position)
Notation example: LI3.7
• Byte No. (decimal): 0 to 3
• Bit position (decimal): 0 to 7

× ×

LQ Logic result Decimal

LQ(Byte No.).(Bit position)
Notation example: LQ3.7
• Byte No. (decimal): 0 to 3
• Bit position (decimal): 0 to 7

× ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/- -/- -/- -/- -/-

Q R/- -/- -/- -/- -/-

LI R/- -/- -/- -/- -/-

LQ R/- -/- -/- -/- -/-
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■3 Monitoring-supported word devices ([MELSEC-WS])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.10 ■4 Availability of writing/reading data to/from word devices ([MELSEC-WS])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSEC-WS])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■5 Engineering software for MELSEC-WS and device representation of GT Designer3 
([MELSEC-WS])

The engineering software for MELSEC-WS and the device representation of GT Designer3 are different.
Set the device by referring to the following table.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

EI EFI input (byte) Decimal

EI(EFI No.)(Device No.)(Byte No.)
Notation example: EI231
• EFI No. (decimal): 1 to 2
• Device No. (decimal): 1 to 3
• Byte No. (decimal): 0 to 3

○ ○

EQ EFI output (byte) Decimal

EQ(EFI No.)(Device No.)(Byte No.)
Notation example: EQ21
• EFI No. (decimal): 1 to 2
• Byte No. (decimal): 0 to 2

○ ○

D Data (byte) Decimal 0 to 99 ○ ○

LD Logic input (byte) Decimal 0 to 3 ○ ○

W Data (word) Decimal 0 to 49 ○ ○

LW Logic input (word) Decimal 0 to 1 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

EI R/- -/- -/- R/-

EQ R/- -/- -/- R/-

D R/- -/- -/- R/-

LD R/- -/- -/- R/-

W R/- R/- -/- R/-

LW R/- R/- -/- R/-

Device name GT Designer3 Engineering software for MELSEC-WS

I*1
I□□.●
□□ (1-12(Dec)): Module number
● (1-8): Input position

▲▲▲▲[□□],I●
▲▲▲▲: I/O model name (such as XTIO and XTDI)
□□ (1-12(Dec)): Module number
● (1-8): Input position

Q*1
Q□□.●
□□ (1-12(Dec)): Module number
●(1-8): Output position

▲▲▲▲ [□□].Q
▲▲▲▲: I/O model name (such as XTIO and XTDI)
□□ (1-12(Dec)): Module number
●(1-8): Output position

LI*1
LI□.●
□ (0-3): Byte number
● (0-7): Bit position

▲▲▲▲[0].□.●
▲▲▲▲: CPU type (CPU0, CPU1)
□ (0-3): Byte number
● (0-7): Bit position
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*1 When the mapping position is changed by the MELSEC-WS engineering software, a mismatch occurs between virtual 
devices on GOT and MELSEC-WS mapping devices.
When mapping is changed, use D devices or LD devices.

■6 Offset specification ([MELSEC-WS])
When devices are set with using the offset function, the device values are as follows.

(1) Input (I)

LQ*1
LQ□.●
□ (0-3): Byte number
● (0-7): Bit position

▲▲□.●
▲▲: Result
□ (0-3): Byte number
● (0-7): Bit position

EI*1

EI○□●
○ (1-2): EFI number
□ (1-3): Device number
● (0-3): Byte number

▲▲▲▲[0].EFI○:□,Byte●
▲▲▲▲: CPU type (CPU0, CPU1)
○ (1-2): EFI number
□ (1-3): Device number
● (0-3): Byte number

EQ*1
EQ○●
○ (1-2): EFI number
● (0-2): Byte number

▲▲▲▲[0].EFI○:1,Byte●
▲▲▲▲: CPU type (CPU0, CPU1)
○ (1-2): EFI number
● (0-2): Byte number

D
D●
●(0-99(Dec)): Byte number

RS232 data
(Safety controller to RS232)

LD
LD●
● (0-3): Byte number

RS232 data
(RS232 to safety controller)

W

W●
● (0-49(Dec)): Word number
Word virtualization of D device
W0 = (D1(Higher-order bits), D0(Lower-order bits))

GOT independent device (Not available)

LW

LW●
● (0-1): Word number
Word virtualization of LD device
LW0 = (LD1(Higher-order bits), LD0(Lower-order bits))

GOT independent device (Not available)

Device name GT Designer3 Engineering software for MELSEC-WS

Offset +0 +1 +2 +3 +4 +5 +6 +7 +8 to +15

+0 I1.1 I1.2 I1.3 I1.4 I1.5 I1.6 I1.7 I1.8

Fixed to 0 (OFF)

+16 I2.1 I2.2 I2.3 I2.4 I2.5 I2.6 I2.7 I2.8

+32 I3.1 I3.2 I3.3 I3.4 I3.5 I3.6 I3.7 I3.8

+48 I4.1 I4.2 I4.3 I4.4 I4.5 I4.6 I4.7 I4.8

+64 I5.1 I5.2 I5.3 I5.4 I5.5 I5.6 I5.7 I5.8

+80 I6.1 I6.2 I6.3 I6.4 I6.5 I6.6 I6.7 I6.8

+96 I7.1 I7.2 I7.3 I7.4 I7.5 I7.6 I7.7 I7.8

+112 I8.1 I8.2 I8.3 I8.4 I8.5 I8.6 I8.7 I8.8

+128 I9.1 I9.2 I9.3 I9.4 I9.5 I9.6 I9.7 I9.8

+144 I10.1 I10.2 I10.3 I10.4 I10.5 I10.6 I10.7 I10.8

+160 I11.1 I11.2 I11.3 I11.4 I11.5 I11.6 I11.7 I11.8

+176 I12.1 I12.2 I12.3 I12.4 I12.5 I12.6 I12.7 I12.8

+192 Device range error
12 - 302 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
(2) Output (Q)

(3) Logic input (LI)

(4) Logic result (LQ)

(5) EFI input (EI)

Offset +0 +1 +2 +3 +4 +5 +6 +7 +8 to +15

+0 Q1.1 Q1.2 Q1.3 Q1.4 Q1.5 Q1.6 Q1.7 Q1.8

Fixed to 0 (OFF)

+16 Q2.1 Q2.2 Q2.3 Q2.4 Q2.5 Q2.6 Q2.7 Q2.8

+32 Q3.1 Q3.2 Q3.3 Q3.4 Q3.5 Q3.6 Q3.7 Q3.8

+48 Q4.1 Q4.2 Q4.3 Q4.4 Q4.5 Q4.6 Q4.7 Q4.8

+64 Q5.1 Q5.2 Q5.3 Q5.4 Q5.5 Q5.6 Q5.7 Q5.8

+80 Q6.1 Q6.2 Q6.3 Q6.4 Q6.5 Q6.6 Q6.7 Q6.8

+96 Q7.1 Q7.2 Q7.3 Q7.4 Q7.5 Q7.6 Q7.7 Q7.8

+112 Q8.1 Q8.2 Q8.3 Q8.4 Q8.5 Q8.6 Q8.7 Q8.8

+128 Q9.1 Q9.2 Q9.3 Q9.4 Q9.5 Q9.6 Q9.7 Q9.8

+144 Q10.1 Q10.2 Q10.3 Q10.4 Q10.5 Q10.6 Q10.7 Q10.8

+160 Q11.1 Q11.2 Q11.3 Q11.4 Q11.5 Q11.6 Q11.7 Q11.8

+176 Q12.1 Q12.2 Q12.3 Q12.4 Q12.5 Q12.6 Q12.7 Q12.8

+192 Device range error

Offset +0 +1 +2 +3 +4 +5 +6 +7

+0 LI0.0 LI0.1 LI0.2 LI0.3 LI0.4 LI0.5 LI0.6 LI0.7

+8 LI1.0 LI1.1 LI1.2 LI1.3 LI1.4 LI1.5 LI1.6 LI1.7

+16 LI2.0 LI2.1 LI2.2 LI2.3 LI2.4 LI2.5 LI2.6 LI2.7

+24 LI3.0 LI3.1 LI3.2 LI3.3 LI3.4 LI3.5 LI3.6 LI3.7

+32 Device range error

Offset +0 +1 +2 +3 +4 +5 +6 +7

+0 LQ0.0 LQ0.1 LQ0.2 LQ0.3 LQ0.4 LQ0.5 LQ0.6 LQ0.7

+8 LQ1.0 LQ1.1 LQ1.2 LQ1.3 LQ1.4 LQ1.5 LQ1.6 LQ1.7

+16 LQ2.0 LQ2.1 LQ2.2 LQ2.3 LQ2.4 LQ2.5 LQ2.6 LQ2.7

+24 LQ3.0 LQ3.1 LQ3.2 LQ3.3 LQ3.4 LQ3.5 LQ3.6 LQ3.7

+32 Device range error

Offset +0 +1 +2 +3 +4 to +15

+0 EI110 EI111 EI112 EI113

Fixed to 0+16 EI120 EI121 EI122 EI123

+32 EI130 EI131 EI132 EI133

+48
:
+240

Fixed to 0

+256 EI210 EI211 EI212 EI213
Fixed to 0

+272 EI220 EI221 EI222 EI223

+288 EI230 EI231 EI232 EI233 Device range error

+302 Device range error
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(6) EFI output (EQ)

Offset +0 +1 +2 +3 to +15

+0 EQ10 EQ11 EQ12 Fixed to 0

+16
:
+240

Fixed to 0

+256 EQ20 EQ21 EQ22 Device range error

+272 Device range error
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12.3.11 [MELIPC]

Not available to GT2105-Q.
This section shows the device range of MELIPC (MI5122-VW).

The settable device range is the same when [MELIPC] is selected and when [MELSEC iQ-R, RnMT/NC/RT, CR800-D] 
is selected.
For the device range when the GOT is connected to the MELSEC iQ-R series, refer to the following.

➟12.3.2 [MELSEC iQ-R, RnMT/NC/RT, CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D]

■1 Monitoring-supported bit devices ([MELIPC])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.2 ■3 Availability of writing/reading data to/from bit devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Item Reference

Specifications of bit devices ➟■1 Monitoring-supported bit devices ([MELIPC])

Specifications of word devices ➟■2 Monitoring-supported word devices ([MELIPC])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

B Link relay Hexadeci
mal 00000 to 9FFFF ○ ○

M Internal relay Decimal 0 to 61439 ○ ○

SM Special relay Decimal 0 to 4095 ○ ○

JnX Link input (link direct) Hexadeci
mal

J(Network No.n)-X(Device)
Notation example: J1-X0000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 3FFF

○ ○

JnY Link output (link direct) Hexadeci
mal

J(Network No.n)-Y(Device)
Notation example: J1-Y0000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 3FFF

○ ○

JnSB Link special relay (link direct) Hexadeci
mal

J(Network No.n)-SB(Device)
Notation example: J1-SB000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 000 to 1FF

○ ○
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■2 Monitoring-supported word devices ([MELIPC])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.2 ■6 Availability of writing/reading data to/from word devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-
D], [MELSEC iQ-R, RnMT/RT, CR800-D])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

D Data register Decimal 0 to 4184063 ○ ○

SD Special register Decimal 0 to 4095 ○ ○

W Link register Hexadeci
mal 00000 to FFFFF ○ ○

ZR Extension file register Decimal 0 to 524287 ○ ○

JnW Link register (link direct) Hexadeci
mal

J(Network No.n)-W(Device)
Notation example: J1-W00000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 0000 to 3FFF

○ ○

JnSW Link special register (link direct) Hexadeci
mal

J(Network No.n)-SW(Device)
Notation example: J1-SW000
• Network No.n (decimal): 1 to 239
• Device (hexadecimal): 000 to 1FF

○ ○

U3E0G CPU buffer memory access 
device Decimal

U3E0-G(Device)
Notation example: U3E0-G100
• Device (decimal): 0 to 199999

○ ○
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12.3.12 [MELSERVO-J2M-P8A]

■1 Monitoring-supported bit devices ([MELSERVO-J2M-P8A])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.12 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-P8A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.12 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-P8A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-P8A])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J2M-P8A])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.12 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-P8A])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J2M-P8A])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-P8A])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J2M-P8A])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-P8A])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J2M-P8A])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-P8A])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J2M-P8A])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 1 to 2 × ×

OM Operation mode selection Decimal 0, 4 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-
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➟12.3.12 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-P8A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-P8A])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■5 Monitoring-supported double-word devices ([MELSERVO-J2M-P8A])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.12 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-P8A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.12 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-P8A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM Parameter Decimal
0 to 29
1000 to 1029

○ ×

ST Status display Decimal 0 to 2 ○ ×

AL Alarm (current alarm) Decimal
0
11 to 13

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

DI External input signal Decimal 0 to 2 × ×

DO External output signal Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PRM R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

DI R/- R/- -/- -/-

DO R/- R/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×
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■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-P8A])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J2M-P8A])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

(1) Servo amplifier request ([MELSERVO-J2M-P8A])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J2M-P8A])

When using the operation mode selection, note the following.

(3) Parameter ([MELSERVO-J2M-P8A])
Use an appropriate device according to the write destination of the servo amplifier.

• PRM0 to PRM29: Writing data to the RAM of a servo amplifier
• PRM1000 to PRM1029: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMO -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J2M-P8A])

OM ➟(2) Operation mode selection ([MELSERVO-J2M-P8A])

PRM ➟(3) Parameter ([MELSERVO-J2M-P8A])

ST ➟(4) Status display ([MELSERVO-J2M-P8A])

AL ➟(5) Alarm ([MELSERVO-J2M-P8A])

DI ➟(6) External input signal ([MELSERVO-J2M-P8A])

DO ➟(7) External output signal ([MELSERVO-J2M-P8A])

TMO ➟(8) Forced output of signal pin (for test operation) ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

SP1 Current alarm clear -

SP2 Alarm history clear -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PRM0, PRM1000 Serial communication function selection, alarm history clear *BPS

PRM1, PRM1001 Regenerative brake option selection *REG

PRM2, PRM1002 Function selection 1 *OP1

PRM3, PRM1003 Analog monitor 1 output MD1
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(4) Status display ([MELSERVO-J2M-P8A])

(5) Alarm ([MELSERVO-J2M-P8A])

PRM4, PRM1004 Analog monitor 2 output MD2

PRM5, PRM1005 Analog monitor 3 output MD3

PRM6, PRM1006 Analog monitor 1 offset MO1

PRM7, PRM1007 Analog monitor 2 offset MO2

PRM8, PRM1008 Analog monitor 3 offset MO3

PRM9, PRM1009 Function selection 2 *OP2

PRM10, PRM1010 Interface unit serial communication number selection *ISN

PRM11, PRM1011 1slot serial communication station number selection *DSN1

PRM12, PRM1012 2slot serial communication station number selection *DSN2

PRM13, PRM1013 3slot serial communication station number selection *DSN3

PRM14, PRM1014 4slot serial communication station number selection *DSN4

PRM15, PRM1015 5slot serial communication station number selection *DSN5

PRM16, PRM1016 6slot serial communication station number selection *DSN6

PRM17, PRM1017 7slot serial communication station number selection *DSN7

PRM18, PRM1018 8slot serial communication station number selection *DSN8

PRM19, PRM1019 Parameter write inhibit *BLK

PRM20, PRM1020 Serial communication time-out selection SIC

PRM21 to PRM29, PRM1021 
to PRM1029 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Regenerative load ratio -

ST1 Bus voltage -

ST2 Peak bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL11 Servo status when alarm occurs, regenerative load ratio -

AL12 Servo status when alarm occurs, bus voltage -

AL13 Servo status when alarm occurs, peak bus voltage -

AL200 Alarm number from alarm history most recent alarm -

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -
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(6) External input signal ([MELSERVO-J2M-P8A])

(7) External output signal ([MELSERVO-J2M-P8A])

(8) Forced output of signal pin (for test operation) ([MELSERVO-J2M-P8A])

When using the forced output of signal pin (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])
(1) Monitoring servo amplifier

Carefully read the manual of servo amplifier to be connected and fully understand the operating procedures before 
monitoring.
Before operation, check the parameter settings and adjust them as required. Improper settings may cause some 
machines to perform unexpected operation.
The parameter settings must not be changed excessively. Operation will be insatiable.

(2) Data length of a virtual device
Set the data length of a virtual device as shown below.

If the above data length is not set, data will be specified incorrectly for the servo amplifier or cannot be properly monitored 
by the GOT.

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 External input pin status CN1A/CN1B - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2M-A Instruction Manual
DI1 External input pin status CN5 -

DI2 External input pin status CN4A/CN4B -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 External output pin status CN1A/CN1B - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2M-A Instruction ManualDO1 External output pin status CN4A/CN4B -

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Virtual device name Name Symbol

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device Data length

PRM, ST, AL, PA, PB, PC, PD, POS, SPD, ACT, 
DCT, DWL, AUX

16 bits or 32 bits
Depending on the servo amplifier data

DI, DO, TMI, TMO, TMD 32 bits

Item Operation

Monitoring
Handling 16-bit data as 32-bit data The upper 16 bits are displayed as 0.

Handling 32-bit data as 16-bit data The lower 16 bits only are displayed.

Writing
The GOT writes within the range of data length set.
Note that the servo amplifier responds correctly while the written data is invalid in the servo amplifier side when the 
written data is out of the range of values which can be set by the servo amplifier.
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(3) Memory to which parameter values are written
Parameter values are written to the RAM or EEPROM of a servo amplifier.

(4) Data type and format settings for using virtual servo amplifier devices (direct connection between the 
GOT and servo amplifier)
To specify virtual servo amplifier devices in the object setting or other settings, the data type and format must be set 
according to the notation of the values handled by the virtual devices.
For notation of the virtual device values, refer to the following.

➟Instruction manual for the servo amplifier used
MR Configurator2 HELP

The following shows a setting example for using virtual servo amplifier devices for an object.
Example) When using a numerical display

(5) Specifying consecutive virtual servo amplifier devices
The GOT does not support writing/reading data to/from consecutive virtual servo amplifier devices.

Write destination Precautions

RAM Remember that the written parameter values are cleared when the servo amplifier is turned off.

EEPROM

The written parameter values are not cleared when the servo amplifier is turned off.
However, there is a limit on the number of times data can be written to EEPROM.
If you update the data frequently (more than once an hour), write parameter values to RAM.
For the details, refer to the manual of the servo amplifier used.

Notation of the virtual device values Setting

Decimal number (positive values only)
• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 65536 or more)
• [Format]: [Unsigned Decimal]

Decimal number (positive and negative 
values)

• [Data Type]: [Signed BIN16] ([Signed BIN32] for -32769 or less, and 32768 or more)
• [Format]: [Signed Decimal]

Hexadecimal number
• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 0x10000 or more)
• [Format]: [Hexadecimal]

Decimal point notation (positive values 
only)

• [Data Type]: [Real]
• [Format]: [Real]
• [Digits (Integral)]: Set the number of digits in the integral portion.
• [Digits (Fractional)]: Set the number of digits in the fractional portion.

Decimal point notation (positive and 
negative values)

When the notation varies by digit

• [Data Type]: [Unsigned BIN16] ([Unsigned BIN32] for 0x10000 or more)
• [Format]: [Hexadecimal]
• On the [Operation/Script] tab, select [Data Operation] for [Operation Type], and set [Bit Mask] or 

[Bit Shift].
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12.3.13 [MELSERVO-J2M-*DU]

■1 Monitoring-supported bit devices ([MELSERVO-J2M-*DU])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.13 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-*DU])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.13 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-*DU])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-*DU])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J2M-*DU])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.13 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-*DU])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J2M-*DU])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2M-*DU])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J2M-*DU])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-*DU])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J2M-*DU])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-*DU])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J2M-*DU])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-*DU])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 0 to 1 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.13 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-*DU])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2M-*DU])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■5 Monitoring-supported double-word devices ([MELSERVO-J2M-*DU])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.13 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-*DU])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.13 ■7 Virtual servo amplifier devices ([MELSERVO-J2M-*DU])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM Parameter Decimal
0 to 84
1000 to 1084

○ ×

ST Status display Decimal 0 to 10 ○ ×

AL Alarm (current alarm) Decimal
0
11 to 21

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PRM R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to 2 × ×
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■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2M-*DU])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J2M-*DU])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

(1) Servo amplifier request ([MELSERVO-J2M-*DU])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J2M-*DU])

When using the operation mode selection, note the following.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J2M-*DU])

OM ➟(2) Operation mode selection ([MELSERVO-J2M-*DU])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J2M-*DU])

PRM ➟(4) Parameter ([MELSERVO-J2M-*DU])

ST ➟(5) Status display ([MELSERVO-J2M-*DU])

AL ➟(6) Alarm ([MELSERVO-J2M-*DU])

TMI ➟(7) Input signal for test operation (for test operation) ([MELSERVO-J2M-*DU])

TMO ➟(8) Forced output of signal pin (for test operation) ([MELSERVO-J2M-*DU])

TMD ➟(9) Set data (for test operation) ([MELSERVO-J2M-*DU])

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(3) Instruction demand (for test operation) ([MELSERVO-J2M-*DU])

When using the instruction demand (for test operation), note the following.

(4) Parameter ([MELSERVO-J2M-*DU])
Use an appropriate device according to the write destination of the servo amplifier.

• PRM0 to PRM84: Writing data to the RAM of a servo amplifier
• PRM1000 to PRM1084: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

TMB0 Clearing acceleration/deceleration time constant -

TMB1 Temporary stop command -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PRM0, PRM1000 For manufacturer setting -

PRM1, PRM1001 Function selection 1 *OP1

PRM2, PRM1002 Auto tuning ATU

PRM3, PRM1003 Electronic gear numerator (Command pulse multiplying factor numerator) CMX

PRM4, PRM1004 Electronic gear denominator (Command pulse multiplying factor denominator) CDV

PRM5, PRM1005 In-position range INP

PRM6, PRM1006 Position control gain 1 PG1

PRM7, PRM1007 Position command acceleration/deceleration time constant (position smoothing) PST

PRM8 to PRM15, PRM1008 
to PRM1015 For manufacturer setting -

PRM16, PRM1016 Alarm history clear *BPS

PRM17 to PRM18, PRM1017 
to PRM1018 For manufacturer setting -

PRM19, PRM1019 DRU parameter block *BLK

PRM20, PRM1020 Function selection 2 *OP2

PRM21, PRM1021 Function selection 3 (Command pulse selection) *OP3

PRM22, PRM1022 Function selection 4 *OP4

PRM23, PRM1023 Feed forward gain FFC

PRM24, PRM1024 Zero speed ZSP

PRM25 to PRM26, PRM1025 
to PRM1026 For manufacturer setting -

PRM27, PRM1027 Encoder output pulses *ENR

PRM28, PRM1028 Internal torque limit 1 TL1

PRM29 to PRM32, PRM1029 
to PRM1032 For manufacturer setting -

PRM33, PRM1033 Electromagnetic brake sequence output MBR

PRM34, PRM1034 Ratio of load inertia moment to servo motor inertia moment GD2

PRM35, PRM1035 Position control gain 2 PG2

PRM36, PRM1036 Speed control gain 1 VG1

PRM37, PRM1037 Speed control gain 2 VG2

PRM38, PRM1038 Speed integral compensation VIC

PRM39, PRM1039 Speed differential compensation VDC

PRM40 to PRM41, PRM1040 
to PRM1041 For manufacturer setting -

PRM42, PRM1042 Input signal selection 1 *DI1
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(5) Status display ([MELSERVO-J2M-*DU])

(6) Alarm ([MELSERVO-J2M-*DU])

PRM43 to PRM50, PRM1043 
to PRM1050 For manufacturer setting -

PRM51, PRM1051 Function selection 6 *OP6

PRM52 to PRM53, PRM1052 
to PRM1053 For manufacturer setting -

PRM54, PRM1054 Function selection 9 *OP9

PRM55, PRM1055 Function selection A *OPA

PRM56 to PRM57, PRM1056 
to PRM1057 For manufacturer setting -

PRM58, PRM1058 Machine resonance suppression filter 1 NH1

PRM59, PRM1059 Machine resonance suppression filter 2 NH2

PRM60, PRM1060 Low-pass filter, adaptive vibration suppression control LPF

PRM61, PRM1061 Ratio of load inertia moment to servo motor inertia moment 2 GD2B

PRM62, PRM1062 Position control gain 2 changing ratio PG2B

PRM63, PRM1063 Speed control gain 2 changing ratio VG2B

PRM64, PRM1064 Speed integral compensation changing ratio VICB

PRM65, PRM1065 Gain changing selection *CDP

PRM66, PRM1066 Gain switching condition CDS

PRM67, PRM1067 Gain switching time constant CDT

PRM68, PRM1068 For manufacturer setting -

PRM69, PRM1069 Command pulse multiplying factor numerator 2 CMX2

PRM70, PRM1070 Command pulse multiplying factor numerator 3 CMX3

PRM71, PRM1071 Command pulse multiplying factor numerator 4 CMX4

PRM72 to PRM75, PRM1072 
to PRM1075 For manufacturer setting -

PRM76, PRM1076 Internal torque limit 2 TL2

PRM77 to PRM84, PRM1077 
to PRM1084 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Cumulative feedback pulses -

ST1 Servo motor speed -

ST2 Droop pulses -

ST3 Cumulative command pulses -

ST4 Command pulse frequency -

ST5 Effective load ratio -

ST6 Peak load ratio -

ST7 Instantaneous torque -

ST8 Within one-revolution position -

ST9 ABS counter -

ST10 Load inertia moment ratio -

Virtual device name Name Symbol

AL0 Current alarm number -

AL11 Servo status when alarm occurs, cumulative feedback pulses -

AL12 Servo status when alarm occurs, servo motor speed -

AL13 Servo status when alarm occurs, droop pulses -

AL14 Servo status when alarm occurs, cumulative command pulses -
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(7) Input signal for test operation (for test operation) ([MELSERVO-J2M-*DU])

When using the input signal for test operation (for test operation), note the following.

(8) Forced output of signal pin (for test operation) ([MELSERVO-J2M-*DU])

When using the forced output of signal pin (for test operation), note the following.

AL15 Servo status when alarm occurs, command pulse frequency -

AL16 Servo status when alarm occurs, effective load ratio -

AL17 Servo status when alarm occurs, peak load ratio -

AL18 Servo status when alarm occurs, instantaneous torque -

AL19 Servo status when alarm occurs, within one-revolution position -

AL20 Servo status when alarm occurs, ABS counter -

AL21 Servo status when alarm occurs, load inertia moment ratio -

AL200 Alarm number from alarm history most recent alarm -

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device name Name Symbol

TMI0 Input signal for test operation -

Virtual device name Name Symbol

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(9) Set data (for test operation) ([MELSERVO-J2M-*DU])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-*DU])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD2 Writes the moving distance in pulses (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.14 [MELSERVO-J2S-*A]

■1 Monitoring-supported bit devices ([MELSERVO-J2S-*A])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.14 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.14 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*A])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J2S-*A])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.14 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*A])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J2S-*A])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*A])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J2S-*A])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*A])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*A])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*A])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J2S-*A])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*A])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 0 to 1 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.14 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*A])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*A])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.14 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.14 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM Parameter Decimal
0 to 84
1000 to 1084

○ ×

ST Status display Decimal 0 to 14 ○ ×

AL Alarm (current alarm) Decimal
0 to 1
11 to 25

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

DI External input signal Decimal 0 × ×

DO External output signal Decimal 0 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PRM R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

DI R/- R/- -/- -/-

DO R/- R/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to 2 × ×
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■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*A])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J2S-*A])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

(1) Servo amplifier request ([MELSERVO-J2S-*A])

When using the servo amplifier request, note the following.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J2S-*A])

OM ➟(2) Operation mode selection ([MELSERVO-J2S-*A])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J2S-*A])

PRM ➟(4) Parameter ([MELSERVO-J2S-*A])

ST ➟(5) Status display ([MELSERVO-J2S-*A])

AL ➟(6) Alarm ([MELSERVO-J2S-*A])

DI ➟(7) External input signal ([MELSERVO-J2S-*A])

DO ➟(8) External output signal ([MELSERVO-J2S-*A])

TMI ➟(9) Input signal for test operation (for test operation) ([MELSERVO-J2S-*A])

TMO ➟(10) Forced output of signal pin (for test operation) ([MELSERVO-J2S-*A])

TMD ➟(11) Set data (for test operation) ([MELSERVO-J2S-*A])

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(2) Operation mode selection ([MELSERVO-J2S-*A])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J2S-*A])

When using the instruction demand (for test operation), note the following.

(4) Parameter ([MELSERVO-J2S-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PRM0 to PRM84: Writing data to the RAM of a servo amplifier
• PRM1000 to PRM1084: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB0 Clearing acceleration/deceleration time constant -

TMB1 Temporary stop command -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PRM0, PRM1000 Control mode, regenerative brake option selection *STY

PRM1, PRM1001 Function selection 1 *OP1

PRM2, PRM1002 Auto tuning ATU

PRM3, PRM1003 Electronic gear numerator (Command pulse multiplying factor numerator) CMX

PRM4, PRM1004 Electronic gear denominator (Command pulse multiplying factor denominator) CDV

PRM5, PRM1005 In-position range INP

PRM6, PRM1006 Position control gain 1 PG1

PRM7, PRM1007 Position command acceleration/deceleration time constant PST

PRM8, PRM1008 Internal speed command1/limit1 SC1

PRM9, PRM1009 Internal speed command2/limit2 SC2

PRM10, PRM1010 Internal speed command3/limit3 SC3

PRM11, PRM1011 Acceleration time constant STA

PRM12, PRM1012 Deceleration time constant STB

PRM13, PRM1013 S-pattern acceleration/deceleration time constant STC

PRM14, PRM1014 Torque command time constant TQC

PRM15, PRM1015 Station number setting *SNO

PRM16, PRM1016 Serial communication function selection, alarm history clear *BPS

PRM17, PRM1017 Analog monitor output MOD

PRM18, PRM1018 Status display selection *DMD

PRM19, PRM1019 Parameter block *BLK

PRM20, PRM1020 Function selection 2 *OP2

PRM21, PRM1021 Function selection 3 (Command pulse selection) *OP3

PRM22, PRM1022 Function selection 4 *OP4
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PRM23, PRM1023 Feed forward gain FFC

PRM24, PRM1024 Zero speed ZSP

PRM25, PRM1025 Analog speed command maximum speed/limit maximum speed VCM

PRM26, PRM1026 Analog torque command maximum output TLC

PRM27, PRM1027 Encoder output pulses *ENR

PRM28, PRM1028 Internal torque limit 1 TL1

PRM29, PRM1029 Analog speed command offset/limit offset VCO

PRM30, PRM1030 Analog torque command offset/limit offset TLO

PRM31, PRM1031 Analog monitor 1 offset MO1

PRM32, PRM1032 Analog monitor 2 offset MO2

PRM33, PRM1033 Electromagnetic brake sequence output MBR

PRM34, PRM1034 Ratio of load inertia moment to servo motor inertia moment GD2

PRM35, PRM1035 Position control gain 2 PG2

PRM36, PRM1036 Speed control gain 1 VG1

PRM37, PRM1037 Speed control gain 2 VG2

PRM38, PRM1038 Speed integral compensation VIC

PRM39, PRM1039 Speed differential compensation VDC

PRM40, PRM1040 For manufacturer setting -

PRM41, PRM1041 Input signal automatic ON selection *DIA

PRM42, PRM1042 Input signal selection 1 *DI1

PRM43, PRM1043 Input signal selection 2 (CN1B-5) *DI2

PRM44, PRM1044 Input signal selection 3 (CN1B-14) *DI3

PRM45, PRM1045 Input signal selection 4 (CN1A-8) *DI4

PRM46, PRM1046 Input signal selection 5 (CN1B-7) *DI5

PRM47, PRM1047 Input signal selection 6 (CN1B-8) *DI6

PRM48, PRM1048 Input signal selection 7 (CN1B-9) *DI7

PRM49, PRM1049 Output signal selection 1 *DO1

PRM50, PRM1050 For manufacturer setting -

PRM51, PRM1051 Function selection 6 *OP6

PRM52, PRM1052 For manufacturer setting -

PRM53, PRM1053 Function selection 8 *OP8

PRM54, PRM1054 Function selection 9 *OP9

PRM55, PRM1055 Function selection A *OPA

PRM56, PRM1056 Serial communication time-out selection SIC

PRM57, PRM1057 For manufacturer setting -

PRM58, PRM1058 Machine resonance suppression filter 1 NH1

PRM59, PRM1059 Machine resonance suppression filter 2 NH2

PRM60, PRM1060 Low-pass filter, adaptive vibration suppression control LPF

PRM61, PRM1061 Ratio of load inertia moment to servo motor inertia moment 2 GD2B

PRM62, PRM1062 Position control gain 2 changing ratio PG2B

PRM63, PRM1063 Speed control gain 2 changing ratio VG2B

PRM64, PRM1064 Speed integral compensation changing ratio VICB

PRM65, PRM1065 Gain changing selection *CDP

PRM66, PRM1066 Gain switching condition CDS

PRM67, PRM1067 Gain switching time constant CDT

PRM68, PRM1068 For manufacturer setting -

PRM69, PRM1069 Command pulse multiplying factor numerator 2 CMX2

Virtual device name Name Symbol
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(5) Status display ([MELSERVO-J2S-*A])

(6) Alarm ([MELSERVO-J2S-*A])

PRM70, PRM1070 Command pulse multiplying factor numerator 3 CMX3

PRM71, PRM1071 Command pulse multiplying factor numerator 4 CMX4

PRM72, PRM1072 Internal speed command4/limit4 SC4

PRM73, PRM1073 Internal speed command5/limit5 SC5

PRM74, PRM1074 Internal speed command6/limit6 SC6

PRM75, PRM1075 Internal speed command7/limit7 SC7

PRM76, PRM1076 Internal torque limit 2 TL2

PRM77 to PRM84, PRM1077 
to PRM1084 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Cumulative feedback pulses -

ST1 Servo motor speed -

ST2 Droop pulses -

ST3 Cumulative command pulses -

ST4 Command pulse frequency -

ST5 Analog speed command voltage/limit voltage -

ST6 Analog torque command voltage/limit voltage -

ST7 Regenerative load ratio -

ST8 Effective load ratio -

ST9 Peak load ratio -

ST10 Instantaneous torque -

ST11 Within one-revolution position -

ST12 ABS counter -

ST13 Load inertia moment ratio -

ST14 Bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs, cumulative feedback pulses -

AL12 Servo status when alarm occurs, servo motor speed -

AL13 Servo status when alarm occurs, droop pulses -

AL14 Servo status when alarm occurs, cumulative command pulses -

AL15 Servo status when alarm occurs, command pulse frequency -

AL16 Servo status when alarm occurs, analog speed command voltage/limit voltage -

AL17 Servo status when alarm occurs, analog torque command voltage/limit voltage -

AL18 Servo status when alarm occurs, regenerative load ratio -

AL19 Servo status when alarm occurs, effective load ratio -

AL20 Servo status when alarm occurs, peak load ratio -

AL21 Servo status when alarm occurs, Instantaneous torque -

AL22 Servo status when alarm occurs, within one-revolution position -

AL23 Servo status when alarm occurs, ABS counter -

AL24 Servo status when alarm occurs, load inertia moment ratio -

AL25 Servo status when alarm occurs, Bus voltage -

AL200 Alarm number from alarm history most recent alarm -
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(7) External input signal ([MELSERVO-J2S-*A])

(8) External output signal ([MELSERVO-J2S-*A])

(9) Input signal for test operation (for test operation) ([MELSERVO-J2S-*A])

When using the input signal for test operation (for test operation), note the following.

(10)Forced output of signal pin (for test operation) ([MELSERVO-J2S-*A])

When using the forced output of signal pin (for test operation), note the following.

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 External input pin statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_A Instruction Manual

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 External output pin statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_A Instruction Manual

Virtual device name Name Symbol

TMI0 Input signal for test operation -

Virtual device name Name Symbol

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(11)Set data (for test operation) ([MELSERVO-J2S-*A])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*A])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD2 Writes the moving distance in pulses (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.15 [MELSERVO-J2S-*CP]

■1 Monitoring-supported bit devices ([MELSERVO-J2S-*CP])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.15 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CP])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.15 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CP])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CP])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J2S-*CP])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.15 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CP])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J2S-*CP])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CP])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J2S-*CP])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CP])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*CP])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CP])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CP])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*CP])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 0 to 1 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.15 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CP])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CP])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for DI0 to DI1.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM Parameter Decimal
0 to 90
1000 to 1090

○ ×

ST Status display Decimal 0 to 16 ○ ×

AL Alarm (current alarm) Decimal
0 to 1
11 to 27

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

POS Point table (position) Decimal
1 to 31
1001 to 1031

○ ×

SPD Point table (speed) Decimal
1 to 31
1001 to 1031

○ ×

ACT Point table (acceleration time 
constant) Decimal

1 to 31
1001 to 1031

○ ×

DCT Point table (deceleration time 
constant) Decimal

1 to 31
1001 to 1031

○ ×

DWL Point table (dwell) Decimal
1 to 31
1001 to 1031

○ ×

AUX Point table (auxiliary function) Decimal
1 to 31
1001 to 1031

○ ×

DI External input signal Decimal 0 to 2 × ×

DO External output signal Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PRM R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-
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■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*CP])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.15 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CP])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.15 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CP])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CP])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CP])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to 2 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J2S-*CP])

OM ➟(2) Operation mode selection ([MELSERVO-J2S-*CP])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J2S-*CP])

PRM ➟(4) Parameter ([MELSERVO-J2S-*CP])

ST ➟(5) Status display ([MELSERVO-J2S-*CP])

AL ➟(6) Alarm ([MELSERVO-J2S-*CP])

POS ➟(7) Point table (position) ([MELSERVO-J2S-*CP])

SPD ➟(8) Point table (speed) ([MELSERVO-J2S-*CP])

ACT ➟(9) Point table (acceleration time constant) ([MELSERVO-J2S-*CP])

DCT ➟(10) Point table (deceleration time constant) ([MELSERVO-J2S-*CP])

DWL ➟(11) Point table (dwell) ([MELSERVO-J2S-*CP])

AUX ➟(12) Point table (auxiliary function) ([MELSERVO-J2S-*CP])

DI ➟(13) External input signal ([MELSERVO-J2S-*CP])

DO ➟(14) External output signal ([MELSERVO-J2S-*CP])

TMI ➟(15) Input signal for test operation (for test operation) ([MELSERVO-J2S-*CP])
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(1) Servo amplifier request ([MELSERVO-J2S-*CP])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J2S-*CP])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J2S-*CP])

When using the instruction demand (for test operation), note the following.

(4) Parameter ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• PRM0 to PRM90: Writing data to the RAM of a servo amplifier
• PRM1000 to PRM1090: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

TMO ➟(16) Forced output of signal pin (for test operation) ([MELSERVO-J2S-*CP])

TMD ➟(17) Set data (for test operation) ([MELSERVO-J2S-*CP])

Virtual device name Reference

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB0 Clearing acceleration/deceleration time constant -

TMB1 Temporary stop command -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PRM0, PRM1000 Command system/regenerative brake option selection *STY

PRM1, PRM1001 Feeding function selection *FTY

PRM2, PRM1002 Function selection 1 *OP1

PRM3, PRM1003 Auto tuning ATU

PRM4, PRM1004 Electronic gear numerator *CMX

PRM5, PRM1005 Electronic gear denominator *CDV
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PRM6, PRM1006 In-position range INP

PRM7, PRM1007 Position control gain 1 PG1

PRM8, PRM1008 Home position return type *ZTY

PRM9, PRM1009 Home position return speed ZRF

PRM10, PRM1010 Creep speed CRF

PRM11, PRM1011 Home position shift distance ZST

PRM12, PRM1012 Rough match output range CRP

PRM13, PRM1013 Jog speed JOG

PRM14, PRM1014 S-pattern acceleration/deceleration time constant *STC

PRM15, PRM1015 Station number setting *SNO

PRM16, PRM1016 Serial communication function selection, alarm history clear *BPS

PRM17, PRM1017 Analog monitor output MOD

PRM18, PRM1018 Status display selection *DMD

PRM19, PRM1019 Parameter block *BLK

PRM20, PRM1020 Function selection 2 *OP2

PRM21, PRM1021 For manufacturer setting -

PRM22, PRM1022 Function selection 4 *OP4

PRM23, PRM1023 Serial communication time-out selection SIC

PRM24, PRM1024 Feed forward gain FFC

PRM25, PRM1025 Override offset VCO

PRM26, PRM1026 Torque limit offset TLO

PRM27, PRM1027 Encoder output pulses *ENR

PRM28, PRM1028 Internal torque limit 1 TL1

PRM29, PRM1029 Internal torque limit 2 TL2

PRM30, PRM1030 Backlash compensation *BKC

PRM31, PRM1031 Analog monitor 1 offset MO1

PRM32, PRM1032 Analog monitor 2 offset MO2

PRM33, PRM1033 Electromagnetic brake sequence output MBR

PRM34, PRM1034 Ratio of load inertia moment to servo motor inertia moment GD2

PRM35, PRM1035 Position control gain 2 PG2

PRM36, PRM1036 Speed control gain 1 VG1

PRM37, PRM1037 Speed control gain 2 VG2

PRM38, PRM1038 Speed integral compensation VIC

PRM39, PRM1039 Speed differential compensation VDC

PRM40 to PRM41, PRM1040 
to PRM1041 For manufacturer setting -

PRM42, PRM1042 Home position return position data *ZPS

PRM43, PRM1043 Moving distance after proximity dog DCT

PRM44, PRM1044 Stopper type home position return stopper time ZTM

PRM45, PRM1045 Stopper type home position return torque limit value ZTT

PRM46, PRM1046
Software limit + *LMP

PRM47, PRM1047

PRM48, PRM1048
Software limit - *LMN

PRM49, PRM1049

PRM50, PRM1050
Position range output address + *LPP

PRM51, PRM1051

PRM52, PRM1052
Position range output address - *LNP

PRM53, PRM1053

Virtual device name Name Symbol
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(5) Status display ([MELSERVO-J2S-*CP])

(6) Alarm ([MELSERVO-J2S-*CP])

PRM54, PRM1054 For manufacturer setting -

PRM55, PRM1055 Function selection 6 *OP6

PRM56, PRM1056 For manufacturer setting -

PRM57, PRM1057 Function selection 8 *OP8

PRM58, PRM1058 Function selection 9 *OP9

PRM59, PRM1059 Function selection A *OPA

PRM60, PRM1060 For manufacturer setting -

PRM61, PRM1061 Machine resonance suppression filter 1 NH1

PRM62, PRM1062 Machine resonance suppression filter 2 NH2

PRM63, PRM1063 Low-pass filter, adaptive vibration suppression control LPF

PRM64, PRM1064 Ratio of load inertia moment to servo motor inertia moment 2 GD2B

PRM65, PRM1065 Position control gain 2 changing ratio PG2B

PRM66, PRM1066 Speed control gain 2 changing ratio VG2B

PRM67, PRM1067 Speed integral compensation changing ratio VICB

PRM68, PRM1068 Gain changing selection *CDP

PRM69, PRM1069 Gain switching condition CDS

PRM70, PRM1070 Gain switching time constant CDT

PRM71 to PRM90, PRM1071 
to PRM1090 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Current position -

ST1 Command position -

ST2 Command remaining distance -

ST3 Point table No. -

ST4 Cumulative feedback pulses -

ST5 Servo motor speed -

ST6 Droop pulses -

ST7 Override -

ST8 Torque limit voltage -

ST9 Regenerative load ratio -

ST10 Effective load ratio -

ST11 Peak load ratio -

ST12 Instantaneous torque -

ST13 Within one-revolution position -

ST14 ABS counter -

ST15 Load inertia moment ratio -

ST16 Bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs, current position -

AL12 Servo status when alarm occurs, command position -

AL13 Servo status when alarm occurs, command remaining distance -

AL14 Servo status when alarm occurs, point table No. -

AL15 Servo status when alarm occurs, cumulative feedback pulses -
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(7) Point table (position) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• POS1 to POS31: Writing data to the RAM of a servo amplifier
• POS1001 to POS1031: Writing data to the EEPROM of a servo amplifier

(8) Point table (speed) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• SPD1 to SPD31: Writing data to the RAM of a servo amplifier
• SPD1001 to SPD1031: Writing data to the EEPROM of a servo amplifier

(9) Point table (acceleration time constant) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• ACT1 to ACT31: Writing data to the RAM of a servo amplifier

AL16 Servo status when alarm occurs, servo motor speed -

AL17 Servo status when alarm occurs, droop pulses -

AL18 Servo status when alarm occurs, override -

AL19 Servo status when alarm occurs, torque limit voltage -

AL20 Servo status when alarm occurs, regenerative load ratio -

AL21 Servo status when alarm occurs, effective load ratio -

AL22 Servo status when alarm occurs, peak load ratio -

AL23 Servo status when alarm occurs, instantaneous torque -

AL24 Servo status when alarm occurs, within one-revolution position -

AL25 Servo status when alarm occurs, ABS counter -

AL26 Servo status when alarm occurs, load inertia moment ratio -

AL27 Servo status when alarm occurs, Bus voltage -

AL200 Alarm number from alarm history most recent alarm -

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device name Name Symbol

Virtual device name Name Symbol

POS1 to POS31, POS1001 to 
POS1031 Point table/position data No. 1 to No. 31 -

Virtual device name Name Symbol

SPD1 to SPD31, SPD1001 to 
SPD1031 Point table/speed data No. 1 to No. 31 -
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• ACT1001 to ACT1031: Writing data to the EEPROM of a servo amplifier

(10)Point table (deceleration time constant) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• DCT1 to DCT31: Writing data to the RAM of a servo amplifier
• DCT1001 to DCT1031: Writing data to the EEPROM of a servo amplifier

(11)Point table (dwell) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• DWL1 to DWL31: Writing data to the RAM of a servo amplifier
• DWL1001 to DWL1031: Writing data to the EEPROM of a servo amplifier

(12)Point table (auxiliary function) ([MELSERVO-J2S-*CP])
Use an appropriate device according to the write destination of the servo amplifier.

• AUX1 to AUX31: Writing data to the RAM of a servo amplifier
• AUX1001 to AUX1031: Writing data to the EEPROM of a servo amplifier

(13)External input signal ([MELSERVO-J2S-*CP])

(14)External output signal ([MELSERVO-J2S-*CP])

(15)Input signal for test operation (for test operation) ([MELSERVO-J2S-*CP])

When using the input signal for test operation (for test operation), note the following.

Virtual device name Name Symbol

ACT1 to ACT31, ACT1001 to 
ACT1031 Point table/acceleration time constant No. 1 to No. 31 -

Virtual device name Name Symbol

DCT1 to DCT31, DCT1001 to 
DCT1031 Point table/deceleration time constant No. 1 to No. 31 -

Virtual device name Name Symbol

DWL1 to DWL31, DWL1001 
to DWL1031 Point table/dwell No. 1 to No. 31 -

Virtual device name Name Symbol

AUX1 to AUX31, AUX1001 to 
AUX1031 Point table/auxiliary function No. 1 to No. 31 -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_CP Instruction Manual

DI1 External input pin statuses -

DI2 Statuses of input devices switched on through 
communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_CP Instruction ManualDO1 External output pin statuses -

Virtual device name Name Symbol

TMI0 Input signal for test operation -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(16)Forced output of signal pin (for test operation) ([MELSERVO-J2S-*CP])

When using the forced output of signal pin (for test operation), note the following.

(17)Set data (for test operation) ([MELSERVO-J2S-*CP])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*CP])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD2 Writes the moving distance in pulses (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.16 [MELSERVO-J2S-*CL]

■1 Monitoring-supported bit devices ([MELSERVO-J2S-*CL])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.16 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CL])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.16 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CL])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CL])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J2S-*CL])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.16 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CL])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J2S-*CL])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J2S-*CL])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J2S-*CL])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CL])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*CL])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CL])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CL])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*CL])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 0 to 1 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.16 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CL])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J2S-*CL])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for DI0 to DI1.

■5 Monitoring-supported double-word devices ([MELSERVO-J2S-*CL])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.16 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CL])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.16 ■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CL])
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM Parameter Decimal
0 to 90
1000 to 1090

○ ×

ST Status display Decimal 0 to 17 ○ ×

AL Alarm (current alarm) Decimal
0 to 1
11 to 28

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

DI External input signal Decimal 0 to 2 × ×

DO External output signal Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PRM R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LD Current position latch data Decimal 1 × ×

RR*2 Value of the general-purpose 
register (Rx) Decimal

1 to 4
1001 to 1004

× ×

RD Value of the general-purpose 
register (Dx) Decimal 1 to 4 × ×

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to 2 × ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Use the integer number when writing parameters to Rx.

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J2S-*CL])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J2S-*CL])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LD -/- R/- -/- -/-

RR -/- R/W -/- -/-

RD -/- R/W -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J2S-*CL])

OM ➟(2) Operation mode selection ([MELSERVO-J2S-*CL])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J2S-*CL])

PRM ➟(4) Parameter ([MELSERVO-J2S-*CL])

ST ➟(5) Status display ([MELSERVO-J2S-*CL])

AL ➟(6) Alarm ([MELSERVO-J2S-*CL])

DI ➟(7) External input signal ([MELSERVO-J2S-*CL])

DO ➟(8) External output signal ([MELSERVO-J2S-*CL])

LD ➟(9) Current position latch data ([MELSERVO-J2S-*CL])

RR ➟(10) Value of the general-purpose register (Rx) ([MELSERVO-J2S-*CL])

RD ➟(11) Value of the general-purpose register (Dx) ([MELSERVO-J2S-*CL])

TMI ➟(12) Input signal for test operation (for test operation) ([MELSERVO-J2S-*CL])

TMO ➟(13) Forced output of signal pin (for test operation) ([MELSERVO-J2S-*CL])

TMD ➟(14) Set data (for test operation) ([MELSERVO-J2S-*CL])
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(1) Servo amplifier request ([MELSERVO-J2S-*CL])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J2S-*CL])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J2S-*CL])

When using the instruction demand (for test operation), note the following.

(4) Parameter ([MELSERVO-J2S-*CL])
Use an appropriate device according to the write destination of the servo amplifier.

• PRM0 to PRM90: Writing data to the RAM of a servo amplifier
• PRM1000 to PRM1090: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB0 Clearing acceleration/deceleration time constant -

TMB1 Temporary stop command -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PRM0, PRM1000 Command system/regenerative brake option selection *STY

PRM1, PRM1001 Feeding function selection *FTY

PRM2, PRM1002 Function selection 1 *OP1

PRM3, PRM1003 Auto tuning ATU

PRM4, PRM1004 Electronic gear numerator *CMX

PRM5, PRM1005 Electronic gear denominator *CDV

PRM6, PRM1006 In-position range INP

PRM7, PRM1007 Position control gain 1 PG1

PRM8, PRM1008 Home position return type *ZTY

PRM9, PRM1009 Home position return speed ZRF
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PRM10, PRM1010 Creep speed CRF

PRM11, PRM1011 Home position shift distance ZST

PRM12, PRM1012 For manufacturer setting -

PRM13, PRM1013 Jog speed JOG

PRM14, PRM1014 S-pattern acceleration/deceleration time constant *STC

PRM15, PRM1015 Station number setting *SNO

PRM16, PRM1016 Serial communication function selection, alarm history clear *BPS

PRM17, PRM1017 Analog monitor output MOD

PRM18, PRM1018 Status display selection *DMD

PRM19, PRM1019 Parameter block *BLK

PRM20, PRM1020 Function selection 2 *OP2

PRM21, PRM1021 For manufacturer setting -

PRM22, PRM1022 Function selection 4 *OP4

PRM23, PRM1023 Serial communication time-out selection SIC

PRM24, PRM1024 Feed forward gain FFC

PRM25, PRM1025 Override offset VCO

PRM26, PRM1026 Torque limit offset TLO

PRM27, PRM1027 Encoder output pulses *ENR

PRM28, PRM1028 Internal torque limit 1 TL1

PRM29, PRM1029 Internal torque limit 2 TL2

PRM30, PRM1030 Backlash compensation *BKC

PRM31, PRM1031 Analog monitor 1 offset MO1

PRM32, PRM1032 Analog monitor 2 offset MO2

PRM33, PRM1033 Electromagnetic brake sequence output MBR

PRM34, PRM1034 Ratio of load inertia moment to servo motor inertia moment GD2

PRM35, PRM1035 Position control gain 2 PG2

PRM36, PRM1036 Speed control gain 1 VG1

PRM37, PRM1037 Speed control gain 2 VG2

PRM38, PRM1038 Speed integral compensation VIC

PRM39, PRM1039 Speed differential compensation VDC

PRM40, PRM1040 JOG operation acceleration/deceleration time constant JTC

PRM41, PRM1041 Home position return operation acceleration/deceleration time constant ZTS

PRM42, PRM1042 Home position return position data *ZPS

PRM43, PRM1043 Moving distance after proximity dog DCT

PRM44, PRM1044 Stopper type home position return stopper time ZTM

PRM45, PRM1045 Stopper type home position return torque limit value ZTT

PRM46, PRM1046
Software limit + *LMP

PRM47, PRM1047

PRM48, PRM1048
Software limit - *LMN

PRM49, PRM1049

PRM50, PRM1050
Position range output address + *LPP

PRM51, PRM1051

PRM52, PRM1052
Position range output address - *LNP

PRM53, PRM1053

PRM54, PRM1054 For manufacturer setting -

PRM55, PRM1055 Function selection 6 *OP6

PRM56, PRM1056 For manufacturer setting -

Virtual device name Name Symbol
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(5) Status display ([MELSERVO-J2S-*CL])

(6) Alarm ([MELSERVO-J2S-*CL])

PRM57, PRM1057 Function selection 8 *OP8

PRM58, PRM1058 Function selection 9 *OP9

PRM59, PRM1059 Function selection A *OPA

PRM60, PRM1060 For manufacturer setting -

PRM61, PRM1061 Machine resonance suppression filter 1 NH1

PRM62, PRM1062 Machine resonance suppression filter 2 NH2

PRM63, PRM1063 Low-pass filter, adaptive vibration suppression control LPF

PRM64, PRM1064 Ratio of load inertia moment to servo motor inertia moment 2 GD2B

PRM65, PRM1065 Position control gain 2 changing ratio PG2B

PRM66, PRM1066 Speed control gain 2 changing ratio VG2B

PRM67, PRM1067 Speed integral compensation changing ratio VICB

PRM68, PRM1068 Gain changing selection *CDP

PRM69, PRM1069 Gain switching condition CDS

PRM70, PRM1070 Gain switching time constant CDT

PRM71 to PRM73, PRM1071 
to PRM1073 For manufacturer setting -

PRM74, PRM1074 OUT1 output time selection OUT1

PRM75, PRM1075 OUT2 output time selection OUT2

PRM76, PRM1076 OUT3 output time selection OUT3

PRM77, PRM1077 Selected to program input polarity selection 1 SYC1

PRM78 to PRM90, PRM1078 
to PRM1090 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Current position -

ST1 Command position -

ST2 Command remaining distance -

ST3 Program Number -

ST4 Step Number -

ST5 Cumulative feedback pulses -

ST6 Servo motor speed -

ST7 Droop pulses -

ST8 Override -

ST9 Torque limit voltage -

ST10 Regenerative load ratio -

ST11 Effective load ratio -

ST12 Peak load ratio -

ST13 Instantaneous torque -

ST14 Within one-revolution position -

ST15 ABS counter -

ST16 Load inertia moment ratio -

ST17 Bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs, current position -
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(7) External input signal ([MELSERVO-J2S-*CL])

AL12 Servo status when alarm occurs, command position -

AL13 Servo status when alarm occurs, command remaining distance -

AL14 Servo status when alarm occurs, program number -

AL15 Servo status when alarm occurs, step number -

AL16 Servo status when alarm occurs, cumulative feedback pulses -

AL17 Servo status when alarm occurs, servo motor speed -

AL18 Servo status when alarm occurs, droop pulses -

AL19 Servo status when alarm occurs, override -

AL20 Servo status when alarm occurs, torque limit voltage -

AL21 Servo status when alarm occurs, regenerative load ratio -

AL22 Servo status when alarm occurs, effective load ratio -

AL23 Servo status when alarm occurs, peak load ratio -

AL24 Servo status when alarm occurs, instantaneous torque -

AL25 Servo status when alarm occurs, within one-revolution position -

AL26 Servo status when alarm occurs, ABS counter -

AL27 Servo status when alarm occurs, load inertia moment ratio -

AL28 Servo status when alarm occurs, Bus voltage -

AL200 Alarm number from alarm history most recent alarm -

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_CL Instruction ManualDI1 External input pin statuses -

DI2 Statuses of input devices switched on through 
communication -

For the mapping of the bits corresponding to the data to be read or written, refer 
to the following.

➟MR-J2S-_CL Instruction Manual

Virtual device name Name Symbol
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(8) External output signal ([MELSERVO-J2S-*CL])

(9) Current position latch data ([MELSERVO-J2S-*CL])

(10)Value of the general-purpose register (Rx) ([MELSERVO-J2S-*CL])
Use an appropriate device according to the write destination of the servo amplifier.

• RR1 to RR4: Writing data to the RAM of a servo amplifier
• RR1001 to RR1004: Writing data to the EEPROM of a servo amplifier

(11)Value of the general-purpose register (Dx) ([MELSERVO-J2S-*CL])

(12)Input signal for test operation (for test operation) ([MELSERVO-J2S-*CL])

When using the input signal for test operation (for test operation), note the following.

(13)Forced output of signal pin (for test operation) ([MELSERVO-J2S-*CL])

When using the forced output of signal pin (for test operation), note the following.

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J2S-_CL Instruction ManualDO1 External output pin statuses -

Virtual device name Name Symbol

LD1 Current position latch data -

Virtual device name Name Symbol

RR1, RR1001 Value of the general-purpose register (R1) -

RR2, RR1002 Value of the general-purpose register (R2) -

RR3, RR1003 Value of the general-purpose register (R3) -

RR4, RR1004 Value of the general-purpose register (R4) -

Virtual device name Name Symbol

RD1 Value of the general-purpose register (D1) -

RD2 Value of the general-purpose register (D2) -

RD3 Value of the general-purpose register (D3) -

RD4 Value of the general-purpose register (D4) -

Virtual device name Name Symbol

TMI0 Input signal for test operation -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(14)Set data (for test operation) ([MELSERVO-J2S-*CL])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2S-*CL])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD2 Writes the moving distance in pulses (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.17 [MELSERVO-J3-*A]

■1 Monitoring-supported bit devices ([MELSERVO-J3-*A])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.17 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.17 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*A])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J3-*A])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.17 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*A])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J3-*A])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*A])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J3-*A])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*A])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J3-*A])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*A])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J3-*A])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J3-*A])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 1 to 6 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.17 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*A])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for DI0 to DI1.

■5 Monitoring-supported double-word devices ([MELSERVO-J3-*A])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.17 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*A])
For details on virtual servo amplifier devices, refer to the following.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic parameter Decimal
1 to 19
1001 to 1019

○ ×

PB Gain filter parameter Decimal
1 to 45
1001 to 1045

○ ×

PC Extension setting parameter Decimal
1 to 50
1001 to 1050

○ ×

PD I/O setting parameter Decimal
1 to 30
1001 to 1030

○ ×

ST Status display Decimal 0 to 14 ○ ×

AL Alarm (current alarm) Decimal
0 to 1
11 to 25

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

DI External input signal Decimal 0 to 2 × ×

DO External output signal Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-
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➟12.3.17 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*A])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J3-*A])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to1, 3 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J3-*A])

OM ➟(2) Operation mode selection ([MELSERVO-J3-*A])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J3-*A])

PA ➟(4) Basic parameter ([MELSERVO-J3-*A])

PB ➟(5) Gain filter parameter ([MELSERVO-J3-*A])

PC ➟(6) Extension setting parameter ([MELSERVO-J3-*A])

PD ➟(7) I/O setting parameter ([MELSERVO-J3-*A])

ST ➟(8) Status display ([MELSERVO-J3-*A])

AL ➟(9) Alarm ([MELSERVO-J3-*A])

DI ➟(10) External input signal ([MELSERVO-J3-*A])

DO ➟(11) External output signal ([MELSERVO-J3-*A])

TMI ➟(12) Input signal for test operation (for test operation) ([MELSERVO-J3-*A])

TMO ➟(13) Forced output of signal pin (for test operation) ([MELSERVO-J3-*A])

TMD ➟(14) Set data (for test operation) ([MELSERVO-J3-*A])
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(1) Servo amplifier request ([MELSERVO-J3-*A])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J3-*A])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J3-*A])

When using the instruction demand (for test operation), note the following.

(4) Basic parameter ([MELSERVO-J3-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA50: Writing data to the RAM of a servo amplifier
• PA1001 to PA1050: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB1 Temporary stop command -

TMB2 Test operation (positioning operation) start command -

TMB3 Forward rotation direction -

TMB4 Reverse rotation direction -

TMB5 Restart for remaining distance -

TMB6 Remaining distance clear -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PA1, PA1001 Control mode *STY

PA2, PA1002 Regenerative brake option *REG

PA3, PA1003 Absolute position detection system *ABS

PA4, PA1004 Function selection A-1 *AOP1

PA5, PA1005 Number of command input pulses per revolution *FBP

PA6, PA1006 Electronic gear numerator (command pulse multiplication numerator) CMX
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(5) Gain filter parameter ([MELSERVO-J3-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB50: Writing data to the RAM of a servo amplifier
• PB1001 to PB1050: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PA7, PA1007 Electronic gear denominator (command pulse multiplication denominator) CDV

PA8, PA1008 Auto tuning mode ATU

PA9, PA1009 Auto tuning response RSP

PA10, PA1010 In-position range INP

PA11, PA1011 Forward rotation torque limit TLP

PA12, PA1012 Reverse rotation torque limit TLN

PA13, PA1013 Command pulse input form *PLSS

PA14, PA1014 Rotation direction selection *POL

PA15, PA1015 Encoder output pulses *ENR

PA16 to PA18, PA1016 to 
PA1018 For manufacturer setting -

PA19, PA1019 Parameter block *BLK

Virtual device name Name Symbol

Virtual device name Name Symbol

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT

PB2, PB1002 Vibration suppression control tuning mode (advanced vibration suppression control) VRFT

PB3, PB1003 Position command acceleration/deceleration time constant (position smoothing) PST

PB4, PB1004 Feed forward gain FFC

PB5, PB1005 For manufacturer setting -

PB6, PB1006 Ratio of load inertia moment to servo motor inertia moment GD2

PB7, PB1007 Model control gain PG1

PB8, PB1008 Position control gain PG2

PB9, PB1009 Speed control gain VG2

PB10, PB1010 Speed integral compensation VIC

PB11, PB1011 Speed differential compensation VDC

PB12, PB1012 For manufacturer setting -

PB13, PB1013 Machine resonance suppression filter 1 NH1

PB14, PB1014 Notch shape selection 1 NHQ1

PB15, PB1015 Machine resonance suppression filter 2 NH2

PB16, PB1016 Notch shape selection 2 NHQ2

PB17, PB1017 For manufacturer setting -

PB18, PB1018 Low-pass filter setting LPF

PB19, PB1019 Vibration suppression control vibration frequency setting VRF1

PB20, PB1020 Vibration suppression control resonance frequency setting VRF2

PB21 to PB22, PB1021 to 
PB1022 For manufacturer setting -

PB23, PB1023 Low-pass filter setting VFBF

PB24, PB1024 Slight vibration suppression control *MVS

PB25, PB1025 Function selection B-1 *BOP1

PB26, PB1026 Gain changing selection *CDP

PB27, PB1027 Gain switching condition CDL

PB28, PB1028 Gain switching time constant CDT

PB29, PB1029 Ratio of load inertia moment to servo motor after gain switching GD2B
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(6) Extension setting parameter ([MELSERVO-J3-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC50: Writing data to the RAM of a servo amplifier
• PC1001 to PC1050: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PB30, PB1030 Position loop gain after gain switching PG2B

PB31, PB1031 Speed loop gain after gain switching VG2B

PB32, PB1032 Speed integral compensation after gain switching VICB

PB33, PB1033 Suppression control and vibration frequency setting after gain switching VRF1B

PB34, PB1034 Suppression control and vibration resonance setting after gain switching VRF2B

PB35 to PB45, PB1035 to 
PB1045 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

PC1, PC1001 Acceleration time constant STA

PC2, PC1002 Deceleration time constant STB

PC3, PC1003 S-pattern acceleration/deceleration time constant STC

PC4, PC1004 Torque command time constant TQC

PC5, PC1005 Internal speed command1/limit1 SC1

PC6, PC1006 Internal speed command2/limit2 SC2

PC7, PC1007 Internal speed command3/limit3 SC3

PC8, PC1008 Internal speed command4/limit4 SC4

PC9, PC1009 Internal speed command5/limit5 SC5

PC10, PC1010 Internal speed command6/limit6 SC6

PC11, PC1011 Internal speed command7/limit7 SC7

PC12, PC1012 Analog speed command maximum speed/limit maximum speed VCM

PC13, PC1013 Analog torque command maximum output TLC

PC14, PC1014 Analog monitor 1 output MOD1

PC15, PC1015 Analog monitor 2 output MOD2

PC16, PC1016 Electromagnetic brake sequence output MBR

PC17, PC1017 Zero speed ZSP

PC18, PC1018 Alarm history clear *BPS

PC19, PC1019 Encoder output pulse selection *ENRS

PC20, PC1020 Station number setting *SNO

PC21, PC1021 Communication function selection *SOP

PC22, PC1022 Function selection C-1 *COP1

PC23, PC1023 Function selection C-2 *COP2

PC24, PC1024 Function selection C-3 *COP3

PC25, PC1025 For manufacturer setting -

PC26, PC1026 Function selection C-5 *COP5

PC27 to PC29, PC1027 to 
PC1029 For manufacturer setting -

PC30, PC1030 Acceleration time constant 2 STA2

PC31, PC1031 Deceleration time constant 2 STB2

PC32, PC1032 Command input pulse multiplication numerator 2 CMX2

PC33, PC1033 Command input pulse multiplication numerator 3 CMX3

PC34, PC1034 Command input pulse multiplication numerator 4 CMX4

PC35, PC1035 Internal torque limit 2 TL2
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(7) I/O setting parameter ([MELSERVO-J3-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD50: Writing data to the RAM of a servo amplifier
• PD1001 to PD1050: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(8) Status display ([MELSERVO-J3-*A])

PC36, PC1036 Status display selection *DMD

PC37, PC1037 Analog speed command offset/limit offset VCO

PC38, PC1038 Analog torque command offset/limit offset TPO

PC39, PC1039 Analog monitor 1 offset MO1

PC40, PC1040 Analog monitor 2 offset MO2

PC41 to PC50, PC1041 to 
PC1050 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

PD1, PD1001 Input signal automatic ON selection 1 *DIA1

PD2, PD1002 For manufacturer setting -

PD3, PD1003 Input device selection 1 (CN1-15) *DI1

PD4, PD1004 Input device selection 2 (CN1-16) *DI2

PD5, PD1005 Input device selection 3 (CN1-17) *DI3

PD6, PD1006 Input device selection 4 (CN1-18) *DI4

PD7, PD1007 Input device selection 5 (CN1-19) *DI5

PD8, PD1008 Input device selection 6 (CN1-41) *DI6

PD9, PD1009 For manufacturer setting -

PD10, PD1010 Input device selection 8 (CN1-43) *DI8

PD11, PD1011 Input device selection 9 (CN1-44) *DI9

PD12, PD1012 Input device selection 10 (CN1-45) *DI10

PD13, PD1013 Output device selection 1 (CN1-22) *DO1

PD14, PD1014 Output device selection 2 (CN1-23) *DO2

PD15, PD1015 Output device selection 3 (CN1-24) *DO3

PD16, PD1016 Output device selection 4 (CN1-25) *DO4

PD17, PD1017 For manufacturer setting -

PD18, PD1018 Output device selection 6 (CN1-49) *DO6

PD19, PD1019 Input filter setting *DIF

PD20, PD1020 Function selection D-1 *DOP1

PD21, PD1021 For manufacturer setting -

PD22, PD1022 Function selection D-3 *DOP3

PD23, PD1023 For manufacturer setting -

PD24, PD1024 Function selection D-5 *DOP5

PD25 to PD30, PD1025 to 
PD1030 For manufacturer setting -

Virtual device name Name Symbol

ST0 Cumulative feedback pulses -

ST1 Servo motor speed -

ST2 Droop pulses -

ST3 Cumulative command pulses -

ST4 Command pulse frequency -

ST5 Analog speed command voltage/limit voltage -
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(9) Alarm ([MELSERVO-J3-*A])

ST6 Analog torque command voltage/limit voltage -

ST7 Regenerative load ratio -

ST8 Effective load ratio -

ST9 Peak load ratio -

ST10 Instantaneous torque -

ST11 Within one-revolution position -

ST12 ABS counter -

ST13 Load inertia moment ratio -

ST14 Bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs, cumulative feedback pulses -

AL12 Servo status when alarm occurs, servo motor speed -

AL13 Servo status when alarm occurs, droop pulses -

AL14 Servo status when alarm occurs, cumulative command pulses -

AL15 Servo status when alarm occurs, command pulse frequency -

AL16 Servo status when alarm occurs, analog speed command voltage/limit voltage -

AL17 Servo status when alarm occurs, analog torque command voltage/limit voltage -

AL18 Servo status when alarm occurs, regenerative load ratio -

AL19 Servo status when alarm occurs, effective load ratio -

AL20 Servo status when alarm occurs, peak load ratio -

AL21 Servo status when alarm occurs, Instantaneous torque -

AL22 Servo status when alarm occurs, within one-revolution position -

AL23 Servo status when alarm occurs, ABS counter -

AL24 Servo status when alarm occurs, load inertia moment ratio -

AL25 Servo status when alarm occurs, bus voltage -

AL200 Alarm number from Alarm History most recent alarm -

AL201 Alarm number from Alarm History first alarm in past -

AL202 Alarm number from Alarm History second alarm in past -

AL203 Alarm number from Alarm History third alarm in past -

AL204 Alarm number from Alarm History fourth alarm in past -

AL205 Alarm number from Alarm History fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from Alarm History most recent alarm -

AL231 Detailed alarm from Alarm History first alarm in past -

AL232 Detailed alarm from Alarm History second alarm in past -

AL233 Detailed alarm from Alarm History third alarm in past -

AL234 Detailed alarm from Alarm History fourth alarm in past -

AL235 Detailed alarm from Alarm History fifth alarm in past -

Virtual device name Name Symbol
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(10)External input signal ([MELSERVO-J3-*A])

(11)External output signal ([MELSERVO-J3-*A])

(12)Input signal for test operation (for test operation) ([MELSERVO-J3-*A])

When using the input signal for test operation (for test operation), note the following.

(13)Forced output of signal pin (for test operation) ([MELSERVO-J3-*A])

When using the forced output of signal pin (for test operation), note the following.

(14)Set data (for test operation) ([MELSERVO-J3-*A])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J3-*A])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J3-_A Instruction Manual

DI1 External input pin statuses -

DI2 Statuses of input devices switched on through 
communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J3-_A Instruction ManualDO1 External output pin statuses -

Virtual device name Name Symbol

TMI0 Input signal for test operation -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD2 For manufacturer setting -

TMD3 Writes the moving distance (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.18 [MELSERVO-J3-*T]

■1 Monitoring-supported bit devices ([MELSERVO-J3-*T])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.18 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*T])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.18 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*T])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*T])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J3-*T])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.18 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*T])
For details on virtual servo amplifier devices, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J3-*T])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J3-*T])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J3-*T])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*T])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J3-*T])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*T])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J3-*T])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J3-*T])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 5 × ×

TMB Instruction demand (for test 
operation) Decimal 1 to 6 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-
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➟12.3.18 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*T])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 MCD cannot be used as a real number.

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J3-*T])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic parameter Decimal
1 to 19
1001 to 1019

○ ×

PB Gain filter parameter Decimal
1 to 45
1001 to 1045

○ ×

PC Extension setting parameter Decimal
1 to 50
1001 to 1050

○ ×

PD I/O setting parameter Decimal
1 to 30
1001 to 1030

○ ×

PO Option unit parameter (PO)*1 Decimal
1 to 35
1001 to 1035

○ ×

ST Status display Decimal 0 to 17 ○ ×

AL Alarm (current alarm) Decimal
0 to 1
11 to 28

○ ×

AL Alarm (alarm history) Decimal
200 to 205
210 to 215
230 to 235

○ ×

POS Point table (position) Decimal
1 to 255
1001 to 1255

○ ×

SPD Point table (speed) Decimal
1 to 255
1001 to 1255

○ ×

ACT Point table (acceleration time 
constant) Decimal

1 to 255
1001 to 1255

○ ×

DCT Point table (deceleration time 
constant) Decimal

1 to 255
1001 to 1255

○ ×

DWL Point table (dwell) Decimal
1 to 255
1001 to 1255

○ ×

AUX Point table (auxiliary function) Decimal
1 to 255
1001 to 1255

○ ×

MCD*2 Point table (M code) Decimal
1 to 255
1001 to 1255

○ ×

DI External input signal Decimal 0 to 7 × ×

DO External output signal Decimal 0 to 4 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PO R/W R/W -/- -/-
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*1 For DI0 to DI4, the GOT can only read data from devices.

■5 Monitoring-supported double-word devices ([MELSERVO-J3-*T])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.18 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*T])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.18 ■7 Virtual servo amplifier devices ([MELSERVO-J3-*T])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J3-*T])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J3-*T])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MCD R/W R/W -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TMI Input signal for test operation (for 
test operation) Decimal 0 to 2 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 to 1 × ×

TMD Set data (for test operation) Decimal 0 to1, 3 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J3-*T])

OM ➟(2) Operation mode selection ([MELSERVO-J3-*T])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J3-*T])
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(1) Servo amplifier request ([MELSERVO-J3-*T])

When using the servo amplifier request, note the following.

PA ➟(4) Basic parameter ([MELSERVO-J3-*T])

PB ➟(5) Gain filter parameter ([MELSERVO-J3-*T])

PC ➟(6) Extension setting parameter ([MELSERVO-J3-*T])

PD ➟(7) I/O setting parameter ([MELSERVO-J3-*T])

PO ➟(8) Option unit parameter ([MELSERVO-J3-*T])

ST ➟(9) Status display ([MELSERVO-J3-*T])

AL ➟(10) Alarm ([MELSERVO-J3-*T])

POS ➟(11) Point table (position) ([MELSERVO-J3-*T])

SPD ➟(12) Point table (speed) ([MELSERVO-J3-*T])

ACT ➟(13) Point table (acceleration time constant) ([MELSERVO-J3-*T])

DCT ➟(14) Point table (deceleration time constant) ([MELSERVO-J3-*T])

DWL ➟(15) Point table (dwell) ([MELSERVO-J3-*T])

AUX ➟(16) Point table (auxiliary function) ([MELSERVO-J3-*T])

MCD ➟(17) Point table (M code) ([MELSERVO-J3-*T])

DI ➟(18) External input signal ([MELSERVO-J3-*T])

DO ➟(19) External output signal ([MELSERVO-J3-*T])

TMI ➟(20) Input signal for test operation (for test operation) ([MELSERVO-J3-*T])

TMO ➟(21) Forced output of signal pin (for test operation) ([MELSERVO-J3-*T])

TMD ➟(22) Set data (for test operation) ([MELSERVO-J3-*T])

Virtual device name Reference

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(2) Operation mode selection ([MELSERVO-J3-*T])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J3-*T])

When using the instruction demand (for test operation), note the following.

(4) Basic parameter ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA19: Writing data to the RAM of a servo amplifier
• PA1001 to PA1019: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM3 Motorless operation -

OM4 Output signal (DO) forced output -

OM5 Single-step feed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB1 Temporary stop command -

TMB2 Test operation (positioning operation) start command -

TMB3 Forward rotation direction -

TMB4 Reverse rotation direction -

TMB5 Restart for remaining distance -

TMB6 Remaining distance clear -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

PA1, PA1001 Control mode *STY

PA2, PA1002 Regenerative brake option *REG

PA3, PA1003 Absolute position detection system *ABS

PA4, PA1004 Function selection A-1 *AOP1

PA5, PA1005 Feeding function selection *FTY

PA6, PA1006 Electronic gear numerator *CMX

PA7, PA1007 Electronic gear denominator *CDV

PA8, PA1008 Auto tuning mode ATU

PA9, PA1009 Auto tuning response RSP

PA10, PA1010 In-position range INP

PA11, PA1011 Forward rotation torque limit TLP

PA12, PA1012 Reverse rotation torque limit TLN

PA13, PA1013 For manufacturer setting -

PA14, PA1014 Rotation direction selection *POL

PA15, PA1015 Encoder output pulses *ENR

PA16 to PA18, PA1016 to 
PA1018 For manufacturer setting -

PA19, PA1019 Parameter block *BLK
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(5) Gain filter parameter ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB45: Writing data to the RAM of a servo amplifier
• PB1001 to PB1045: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(6) Extension setting parameter ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC50: Writing data to the RAM of a servo amplifier

Virtual device name Name Symbol

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT

PB2, PB1002 Vibration suppression control tuning mode (advanced vibration suppression control) VRFT

PB3, PB1003 For manufacturer setting -

PB4, PB1004 Feed forward gain FFC

PB5, PB1005 For manufacturer setting -

PB6, PB1006 Ratio of load inertia moment to servo motor inertia moment GD2

PB7, PB1007 Model control gain PG1

PB8, PB1008 Position control gain PG2

PB9, PB1009 Speed control gain VG2

PB10, PB1010 Speed integral compensation VIC

PB11, PB1011 Speed differential compensation VDC

PB12, PB1012 For manufacturer setting -

PB13, PB1013 Machine resonance suppression filter 1 NH1

PB14, PB1014 Notch shape selection 1 NHQ1

PB15, PB1015 Machine resonance suppression filter 2 NH2

PB16, PB1016 Notch shape selection 2 NHQ2

PB17, PB1017 For manufacturer setting -

PB18, PB1018 Low-pass filter setting LPF

PB19, PB1019 Vibration suppression control vibration frequency setting VRF1

PB20, PB1020 Vibration suppression control resonance frequency setting VRF2

PB21 to PB22, PB1021 to 
PB1022 For manufacturer setting -

PB23, PB1023 Low-pass filter setting VFBF

PB24, PB1024 Slight vibration suppression control *MVS

PB25, PB1025 For manufacturer setting -

PB26, PB1026 Gain changing selection *CDP

PB27, PB1027 Gain switching condition CDL

PB28, PB1028 Gain switching time constant CDT

PB29, PB1029 Ratio of load inertia moment to servo motor after gain switching GD2B

PB30, PB1030 Position loop gain after gain switching PG2B

PB31, PB1031 Speed loop gain after gain switching VG2B

PB32, PB1032 Speed integral compensation after gain switching VICB

PB33, PB1033 Suppression control and vibration frequency setting after gain switching VRF1B

PB34, PB1034 Suppression control and vibration resonance setting after gain switching VRF2B

PB35 to PB45, PB1035 to 
PB1045 For manufacturer setting -
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• PC1001 to PC1050: Writing data to the EEPROM of a servo amplifier
For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

PC1, PC1001 For manufacturer setting -

PC2, PC1002 Home position return type *ZTY

PC3, PC1003 Direction of home position return *ZDIR

PC4, PC1004 Home position return speed ZRF

PC5, PC1005 Creep speed CRF

PC6, PC1006 Home position shift distance ZST

PC7, PC1007 Home position return position data *ZPS

PC8, PC1008 Moving distance after proximity dog DCT

PC9, PC1009 Stopper type home position return stopper time ZTM

PC10, PC1010 Stopper type home position return torque limit value ZTT

PC11, PC1011 Rough match output range CRP

PC12, PC1012 Jog speed JOG

PC13, PC1013 S-pattern acceleration/deceleration time constant *STC

PC14, PC1014 Backlash compensation *BKC

PC15, PC1015 For manufacturer setting -

PC16, PC1016 Electromagnetic brake sequence output MBR

PC17, PC1017 Zero speed ZSP

PC18, PC1018 Alarm history clear *BPS

PC19, PC1019 Encoder output pulse selection *ENRS

PC20, PC1020 Station number setting *SNO

PC21, PC1021 RS-422 communication function selection *SOP

PC22, PC1022 Function selection C-1 *COP1

PC23, PC1023 For manufacturer setting -

PC24, PC1024 Function selection C-3 *COP3

PC25, PC1025 For manufacturer setting -

PC26, PC1026 Function selection C-5 *COP5

PC27, PC1027 For manufacturer setting -

PC28, PC1028 Function selection C-7 *COP7

PC29 to PC30, PC1029 to 
PC1030 For manufacturer setting -

PC31, PC1031 Software limit + Low LMPL

PC32, PC1032 Software limit + High LMPH

PC33, PC1033 Software limit - Low LMNL

PC34, PC1034 Software limit - High LMNH

PC35, PC1035 Internal torque limit 2 TL2

PC36, PC1036 Status display selection *DMD

PC37, PC1037 Position range output address + Low *LPPL

PC38, PC1038 Position range output address + High *LPPH

PC39, PC1039 Position range output address - Low *LNPL

PC40, PC1040 Position range output address - High *LNPH

PC41 to PC50, PC1041 to 
PC1050 For manufacturer setting -
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(7) I/O setting parameter ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD30: Writing data to the RAM of a servo amplifier
• PD1001 to PD1030: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(8) Option unit parameter ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• PO1 to PO35: Writing data to the RAM of a servo amplifier
• PO1001 to PO1035: Writing data to the EEPROM of a servo amplifier

Virtual device name Name Symbol

PD1, PD1001 Input signal automatic ON selection 1 *DIA1

PD2, PD1002 For manufacturer setting -

PD3, PD1003 Input signal automatic ON selection 3 *DIA3

PD4, PD1004 Input signal automatic ON selection 4 *DIA4

PD5, PD1005 For manufacturer setting -

PD6, PD1006 Input device selection 2 (CN6-2) *DI2

PD7, PD1007 Input device selection 3 (CN6-3) *DI3

PD8, PD1008 Input device selection 4 (CN6-4) *DI4

PD9, PD1009 Output signal device selection 1 (CN6-14) *DO1

PD10, PD1010 Output signal device selection 2 (CN6-15) *DO2

PD11, PD1011 Output signal device selection 3 (CN6-16) *DD3

PD12 to PD15, PD1012 to 
PD1015 For manufacturer setting -

PD16, PD1016 Input polarity selection *DIAB

PD17 to PD18, PD1017 to 
PD1018 For manufacturer setting -

PD19, PD1019 Input filter setting *DIF

PD20, PD1020 Function selection D-1 *DOP1

PD21, PD1021 For manufacturer setting -

PD22, PD1022 Function selection D-3 *DOP3

PD23, PD1023 For manufacturer setting -

PD24, PD1024 Function selection D-5 *DOP5

PD25 to PD30, PD1025 to 
PD1030 For manufacturer setting -

Virtual device name Name Symbol

PO1, PO1001 For manufacturer setting -

PO2, PO1002 MR-J3-D01 Input signal device selection 1 (CN10-21, 26) *ODI1

PO3, PO1003 MR-J3-D01 Input signal device selection 2 (CN10-27, 28) *ODI2

PO4, PO1004 MR-J3-D01 Input signal device selection 3 (CN10-29, 30) *ODI3

PO5, PO1005 MR-J3-D01 Input signal device selection 4 (CN10-31, 32) *ODI4

PO6, PO1006 MR-J3-D01 Input signal device selection 5 (CN10-33, 34) *ODI5

PO7, PO1007 MR-J3-D01 Input signal device selection 6 (CN10-35, 36) *ODI6

PO8, PO1008 MR-J3-D01 Output signal device selection 1 (CN10-46, 47) *ODO1

PO9, PO1009 MR-J3-D01 Output signal device selection 2 (CN10-48, 49) *ODO2

PO10, PO1010 Function selection 0-1 *OOP1

PO11, PO1011 For manufacturer setting -

PO12, PO1012 Function selection 0-3 *OOP3

PO13, PO1013 MR-J3-D01 Analog monitor 1 output MOD1

PO14, PO1014 MR-J3-D01 Analog monitor 2 output MOD2
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(9) Status display ([MELSERVO-J3-*T])

(10)Alarm ([MELSERVO-J3-*T])

PO15, PO1015 MR-J3-D01 Analog monitor 1 offset MO1

PO16, PO1016 MR-J3-D01 Analog monitor 2 offset MO2

PO17 to 20, PO1017 to 
PO1020 For manufacturer setting -

PO21, PO1021 MR-J3-D01 Override offset VCO

PO22, PO1022 MR-J3-D01 Analog torque limitation offset TLO

PO23 to PO35, PO1023 to 
PO1035 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Current position -

ST1 Command position -

ST2 Command remaining distance -

ST3 Point table No. -

ST4 Cumulative feedback pulses -

ST5 Servo motor speed -

ST6 Droop pulses -

ST7 Override voltage -

ST8 Override -

ST9 Analog torque command voltage/limit voltage -

ST10 Regenerative load ratio -

ST11 Effective load ratio -

ST12 Peak load ratio -

ST13 Instantaneous torque -

ST14 Within one-revolution position -

ST15 ABS counter -

ST16 Load inertia moment ratio -

ST17 Bus voltage -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs, current position -

AL12 Servo status when alarm occurs, command position -

AL13 Servo status when alarm occurs, command remaining distance -

AL14 Servo status when alarm occurs, point table No. -

AL15 Servo status when alarm occurs, cumulative feedback pulses -

AL16 Servo status when alarm occurs, servo motor speed -

AL17 Servo status when alarm occurs, droop pulses -

AL18 Servo status when alarm occurs, override voltage -

AL19 Servo status when alarm occurs, override -

AL20 Servo status when alarm occurs, analog torque limit voltage -

AL21 Servo status when alarm occurs, regenerative load ratio -

AL22 Servo status when alarm occurs, effective load ratio -

AL23 Servo status when alarm occurs, peak load ratio -

AL24 Servo status when alarm occurs, Instantaneous torque -

AL25 Servo status when alarm occurs, within one-revolution position -
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(11)Point table (position) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• POS1 to POS255: Writing data to the RAM of a servo amplifier
• POS1001 to POS1255: Writing data to the EEPROM of a servo amplifier

(12)Point table (speed) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• SPD1 to SPD255: Writing data to the RAM of a servo amplifier
• SPD1001 to SPD1255: Writing data to the EEPROM of a servo amplifier

(13)Point table (acceleration time constant) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• ACT1 to ACT255: Writing data to the RAM of a servo amplifier
• ACT1001 to ACT1255: Writing data to the EEPROM of a servo amplifier

AL26 Servo status when alarm occurs, ABS counter -

AL27 Servo status when alarm occurs, load inertia moment ratio -

AL28 Servo status when alarm occurs, Bus voltage -

AL200 Alarm number from alarm history most recent alarm -

AL201 Alarm number from alarm history first alarm in past -

AL202 Alarm number from alarm history second alarm in past -

AL203 Alarm number from alarm history third alarm in past -

AL204 Alarm number from alarm history fourth alarm in past -

AL205 Alarm number from alarm history fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from alarm history most recent alarm -

AL231 Detailed alarm from alarm history first alarm in past -

AL232 Detailed alarm from alarm history second alarm in past -

AL233 Detailed alarm from alarm history third alarm in past -

AL234 Detailed alarm from alarm history fourth alarm in past -

AL235 Detailed alarm from alarm history fifth alarm in past -

Virtual device name Name Symbol

Virtual device name Name Symbol

POS1 to POS255, POS1001 
to POS1255 Point table/position data No. 1 to No. 255 -

Virtual device name Name Symbol

SPD1 to SPD255, SPD1001 
to SPD1255 Point table/speed data No. 1 to No. 255 -

Virtual device name Name Symbol

ACT1 to ACT255, ACT1001 
to ACT1255 Point table/acceleration time constant No. 1 to No. 255 -
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(14)Point table (deceleration time constant) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• DCT1 to DCT255: Writing data to the RAM of a servo amplifier
• DCT1001 to DCT1255: Writing data to the EEPROM of a servo amplifier

(15)Point table (dwell) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• DWL1 to DWL255: Writing data to the RAM of a servo amplifier
• DWL1001 to DWL1255: Writing data to the EEPROM of a servo amplifier

(16)Point table (auxiliary function) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• AUX1 to AUX255: Writing data to the RAM of a servo amplifier
• AUX1001 to AUX1255: Writing data to the EEPROM of a servo amplifier

(17)Point table (M code) ([MELSERVO-J3-*T])
Use an appropriate device according to the write destination of the servo amplifier.

• MCD1 to MCD255: Writing data to the RAM of a servo amplifier
• MCD1001 to MCD1255: Writing data to the EEPROM of a servo amplifier

(18)External input signal ([MELSERVO-J3-*T])

(19)External output signal ([MELSERVO-J3-*T])

Virtual device name Name Symbol

DCT1 to DCT255, DCT1001 
to DCT1255 Point table/deceleration time constant No. 1 to No. 255 -

Virtual device name Name Symbol

DWL1 to DWL255, DWL1001 
to DWL1255 Point table/dwell No. 1 to No. 255 -

Virtual device name Name Symbol

AUX1 to AUX255, AUX1001 
to AUX1255 Point table/auxiliary function No. 1 to No. 255 -

Virtual device name Name Symbol

MCD1 to MCD255, MCD1001 
to MCD1255 Point table/M code No.1 to No.255 -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J3-_T Instruction Manual
DI1 Input device statuses -

DI3 External input pin statuses -

DI5 Statuses of input devices switched on through 
communication - For the mapping of the bits corresponding to the data to be read or written, refer 

to the following.

➟MR-J3-_T Instruction ManualDI6 Statuses of input devices switched on through 
communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J3-_T Instruction Manual
DO1 Output device statuses -

DO3 External output pin statuses -
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(20)Input signal for test operation (for test operation) ([MELSERVO-J3-*T])

When using the input signal for test operation (for test operation), note the following.

(21)Forced output of signal pin (for test operation) ([MELSERVO-J3-*T])

When using the forced output of signal pin (for test operation), note the following.

(22)Set data (for test operation) ([MELSERVO-J3-*T])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J3-*T])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMI0 Input signal for test operation 1 -

TMI1 Input signal for test operation 2 -

TMI2 Input signal for test operation 3 -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output from signal pin (CN6) -

TMO1 Forced output from signal pin (CN10) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD3 Writes the moving distance (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.19 [MELSERVO-J4-*A, -JE-*A]

■1 Monitoring-supported bit devices ([MELSERVO-J4-*A, -JE-*A])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.19 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A, -JE-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.19 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A, -JE-*A])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J4-*A, -JE-*A])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A, -JE-*A])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J4-*A, -JE-*A])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A, -JE-*A])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J4-*A, -JE-*A])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A, -JE-*A])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 4 × ×

TMB Instruction demand (for test 
operation) Decimal 1 to 6 × ×

OTI One-touch tuning instruction Decimal 0 to 5 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-
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■3 Monitoring-supported word devices ([MELSERVO-J4-*A, -JE-*A])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.19 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A, -JE-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.19 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A, -JE-*A])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic parameter Decimal
1 to 32
1001 to 1032

○ ×

PB Gain filter parameter Decimal
1 to 64
1001 to 1064

○ ×

PC Extension setting parameter Decimal
1 to 80
1001 to 1080

○ ×

PD I/O setting parameter Decimal
1 to 48
1001 to 1048

○ ×

PL Linear servo motor/DD motor 
setting parameter Decimal

1 to 48
1001 to 1048

○ ×

ST Status display Decimal 0 to 41 ○ ×

AL Alarm (current alarm, J3A 
compatible) Decimal

0 to 1
11 to 25

○ ×

AL Alarm (alarm history, J3A 
compatible) Decimal

200 to 205
210 to 215
230 to 235

○ ×

PE Extension setting No.2 parameter Decimal
1 to 64
1001 to 1064

○ ×

PF Extension setting No.3 parameter Decimal
1 to 48
1001 to 1048

○ ×

ALM Alarm (current alarm, J4A extend) Decimal
0 to 1
11 to 52

○ ×

ALM Alarm (alarm history, J4A extend) Decimal
200 to 215
220 to 235
240 to 255

○ ×

MD Machine diagnosis data Decimal 0 to 11 × ×

OTS One-touch tuning data Decimal 0 to 3 × ×

DI External input signal Decimal 0 to 2 × ×

DO External output signal Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-
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*1 Only reading is available for DI0 and DI1.

■5 Monitoring-supported double-word devices ([MELSERVO-J4-*A, -JE-*A])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.19 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A, -JE-*A])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.19 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A, -JE-
*A])

The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

PL R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

MD R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

ALD Life diagnosis Decimal 0 to 1 × ×

TMI Input signal for test operation (for 
test operation) Decimal 0 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to1, 3 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 369



■7 Virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

(1) Servo amplifier request ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the servo amplifier request, note the following.

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J4-*A, -JE-*A])

OM ➟(2) Operation mode selection ([MELSERVO-J4-*A, -JE-*A])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J4-*A, -JE-*A])

OTI ➟(4) One-touch tuning instruction ([MELSERVO-J4-*A, -JE-*A])

PA ➟(5) Basic parameter ([MELSERVO-J4-*A, -JE-*A])

PB ➟(6) Gain filter parameter ([MELSERVO-J4-*A, -JE-*A])

PC ➟(7) Extension setting parameter ([MELSERVO-J4-*A, -JE-*A])

PD ➟(8) I/O setting parameter ([MELSERVO-J4-*A, -JE-*A])

PL ➟(9) Linear servo motor/DD motor setting parameter ([MELSERVO-J4-*A, -JE-*A])

ST ➟(10) Status display ([MELSERVO-J4-*A, -JE-*A])

AL ➟(11) Alarm (MELSERVO-J3-*A compatible) ([MELSERVO-J4-*A, -JE-*A])

PE ➟(12) Extension setting No.2 parameter ([MELSERVO-J4-*A, -JE-*A])

PF ➟(13) Extension setting No.3 parameter ([MELSERVO-J4-*A, -JE-*A])

ALM ➟(14) Alarm (MELSERVO-J4-*A extended) ([MELSERVO-J4-*A, -JE-*A])

MD ➟(15) Machine diagnosis data ([MELSERVO-J4-*A, -JE-*A])

OTS ➟(16) One-touch tuning data ([MELSERVO-J4-*A, -JE-*A])

DI
➟(17) External input signal in MR-J4-□A ([MELSERVO-J4-*A, -JE-*A])

➟(18) External input signal in MR-JE-□A ([MELSERVO-J4-*A, -JE-*A])

DO
➟(19) External output signal in MR-J4-□A ([MELSERVO-J4-*A, -JE-*A])

➟(20) External output signal in MR-JE-□A ([MELSERVO-J4-*A, -JE-*A])

ALD ➟(21) Life diagnosis ([MELSERVO-J4-*A, -JE-*A])

TMI ➟(22) Input signal for test operation (for test operation) ([MELSERVO-J4-*A, -JE-*A])

TMO ➟(23) Forced output of signal pin (for test operation) ([MELSERVO-J4-*A, -JE-*A])

TMD ➟(24) Set data (for test operation) ([MELSERVO-J4-*A, -JE-*A])

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

SP0 Status display data clear - ○ ○

SP1 Current alarm clear - ○ ○

SP2 Alarm history clear - ○ ○

SP3 External input signal prohibited - ○ ○

SP4 External output signal prohibited - ○ ○

SP5 External input signal resumed - ○ ○

SP6 External output signal resumed - ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(2) Operation mode selection ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the instruction demand (for test operation), note the following.

(4) One-touch tuning instruction ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

(5) Basic parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA32: Writing data to the RAM of a servo amplifier
• PA1001 to PA1032: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

OM0 Normal mode (not test operation mode) - ○ ○

OM1 JOG operation - ○ ○

OM2 Positioning operation - ○ ○

OM4 Output signal (DO) forced output - ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

TMB1 Temporary stop command - ○ ○

TMB2 Test operation (positioning operation) start command - ○ ○

TMB3 Forward rotation direction - ○ ○

TMB4 Reverse rotation direction - ○ ○

TMB5 Restart for remaining distance - ○ ○

TMB6 Remaining distance clear - ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

OTI0 One-touch tuning start command (Basic mode) - ○ ○

OTI1 One-touch tuning start command (High mode) - ○ ○

OTI2 One-touch tuning start command (Low mode) - ○ ○

OTI3 One-touch tuning stop command - ○ ○

OTI4 Return to initial value - ○ ○

OTI5 Return to value before adjustment - ○ ○

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PA1, PA1001 Operation mode *STY ○ ○

PA2, PA1002 Regenerative brake option *REG ○ ○

PA3, PA1003 Absolute position detection system *ABS ○ ×

PA4, PA1004 Function selection A-1 *AOP1 ○ ○

PA5, PA1005 Number of command input pulses per revolution *FBP ○ ○
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(6) Gain filter parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB64: Writing data to the RAM of a servo amplifier
• PB1001 to PB1064: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PA6, PA1006 Electronic gear numerator (command pulse multiplication 
numerator) CMX ○ ○

PA7, PA1007 Electronic gear denominator (command pulse multiplication 
denominator) CDV ○ ○

PA8, PA1008 Auto tuning mode ATU ○ ○

PA9, PA1009 Auto tuning response RSP ○ ○

PA10, PA1010 In-position range INP ○ ○

PA11, PA1011 Forward rotation torque limit TLP ○ ○

PA12, PA1012 Reverse rotation torque limit TLN ○ ○

PA13, PA1013 Command pulse input form *PLSS ○ ○

PA14, PA1014 Rotation direction selection *POL ○ ○

PA15, PA1015 Encoder output pulses *ENR ○ ○

PA16, PA1016 Encoder output pulses 2 *ENR2 ○ ○

PA17 to PA18, 
PA1017 to PA1018 For manufacturer setting - × ×

PA19, PA1019 Parameter block *BLK ○ ○

PA20, PA1020 Tough drive setting *TDS ○ ○

PA21, PA1021 Function selection A-3 *AOP3 ○ ○

PA22, PA1022 For manufacturer setting - × ×

PA23, PA1023 Drive recorder arbitrary alarm trigger setting DRAT ○ ○

PA24, PA1024 Function selection A-4 *AOP4 ○ ○

PA25, PA1025 One-touch tuning - Overshoot permissible level OTHOV ○ ○

PA26, PA1026 Function selection A-5 *AOP5 × ○

PA27 to PA32, 
PA1027 to PA1032 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT ○ ○

PB2, PB1002 Vibration suppression control tuning mode (advanced 
vibration suppression control) VRFT ○ ○

PB3, PB1003 Position command acceleration/deceleration time constant 
(position smoothing) PST ○ ○

PB4, PB1004 Feed forward gain FFC ○ ○

PB5, PB1005 For manufacturer setting - × ×

PB6, PB1006 Load inertia moment ratio GD2 ○ ○

PB7, PB1007 Model control gain PG1 ○ ○

PB8, PB1008 Position control gain PG2 ○ ○

PB9, PB1009 Speed control gain VG2 ○ ○

PB10, PB1010 Speed integral compensation VIC ○ ○

PB11, PB1011 Speed differential compensation VDC ○ ○

PB12, PB1012 Overshoot amount compensation OVA ○ ○

PB13, PB1013 Machine resonance suppression filter 1 NH1 ○ ○

PB14, PB1014 Notch shape selection 1 NHQ1 ○ ○

PB15, PB1015 Machine resonance suppression filter 2 NH2 ○ ○
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PB16, PB1016 Notch shape selection 2 NHQ2 ○ ○

PB17, PB1017 Shaft resonance suppression filter NHF ○ ○

PB18, PB1018 Low-pass filter setting LPF ○ ○

PB19, PB1019 Vibration suppression control 1 - Vibration frequency VRF11 ○ ○

PB20, PB1020 Vibration suppression control 1 - Resonance frequency VRF12 ○ ○

PB21, PB1021 Vibration suppression control 1 - Vibration frequency damping VRF13 ○ ○

PB22, PB1022 Vibration suppression control 1 - Resonance frequency 
damping VRF14 ○ ○

PB23, PB1023 Low-pass filter setting VFBF ○ ○

PB24, PB1024 Slight vibration suppression control *MVS ○ ○

PB25, PB1025 Function selection B-1 *BOP1 ○ ○

PB26, PB1026 Gain switching function *CDP ○ ○

PB27, PB1027 Gain switching condition CDL ○ ○

PB28, PB1028 Gain switching time constant CDT ○ ○

PB29, PB1029 Load to motor inertia ratio after gain switching GD2B ○ ○

PB30, PB1030 Position loop gain after gain switching PG2B ○ ○

PB31, PB1031 Speed loop gain after gain switching VG2B ○ ○

PB32, PB1032 Speed integral compensation after gain switching VICB ○ ○

PB33, PB1033 Vibration suppression control 1 - Vibration frequency after gain 
switching VRF1B ○ ○

PB34, PB1034 Vibration suppression control 1 - Resonance frequency after 
gain switching VRF2B ○ ○

PB35, PB1035 Vibration suppression control 1 - Vibration frequency damping 
after gain switching VRF3B ○ ○

PB36, PB1036 Vibration suppression control 1 - Resonance frequency 
damping after gain switching VRF4B ○ ○

PB37 to PB44, 
PB1037 to PB1044 For manufacturer setting - × ×

PB45, PB1045 Command notch filter CNHF ○ ○

PB46, PB1046 Machine resonance suppression filter 3 NH3 ○ ○

PB47, PB1047 Notch shape selection 3 NHQ3 ○ ○

PB48, PB1048 Machine resonance suppression filter 4 NH4 ○ ○

PB49, PB1049 Notch shape selection 4 NHQ4 ○ ○

PB50, PB1050 Machine resonance suppression filter 5 NH5 ○ ○

PB51, PB1051 Notch shape selection 5 NHQ5 ○ ○

PB52, PB1052 Vibration suppression control 2 - Vibration frequency VRF21 ○ ○

PB53, PB1053 Vibration suppression control 2 - Resonance frequency VRF22 ○ ○

PB54, PB1054 Vibration suppression control 2 - Vibration frequency damping VRF23 ○ ○

PB55, PB1055 Vibration suppression control 2 - Resonance frequency 
damping VRF24 ○ ○

PB56, PB1056 Vibration suppression control 2 - Vibration frequency after gain 
switching VRF21B ○ ○

PB57, PB1057 Vibration suppression control 2 - Resonance frequency after 
gain switching VRF22B ○ ○

PB58, PB1058 Vibration suppression control 2 - Vibration frequency damping 
after gain switching VRF23B ○ ○

PB59, PB1059 Vibration suppression control 2 - Resonance frequency 
damping after gain switching VRF24B ○ ○

PB60, PB1060 Model loop gain after gain switching PG1B ○ ○

PB61 to PB64, 
PB1061 to PB1064 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A
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(7) Extension setting parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC80: Writing data to the RAM of a servo amplifier
• PC1001 to PC1080: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PC1, PC1001 Acceleration time constant STA ○ ○

PC2, PC1002 Deceleration time constant STB ○ ○

PC3, PC1003 S-pattern acceleration/deceleration time constant STC ○ ○

PC4, PC1004 Torque command time constant TQC ○ ○

PC5, PC1005 Internal speed command1/limit1 SC1 ○ ○

PC6, PC1006 Internal speed command2/limit2 SC2 ○ ○

PC7, PC1007 Internal speed command3/limit3 SC3 ○ ○

PC8, PC1008 Internal speed command4/limit4 SC4 ○ ○

PC9, PC1009 Internal speed command5/limit5 SC5 ○ ○

PC10, PC1010 Internal speed command6/limit6 SC6 ○ ○

PC11, PC1011 Internal speed command7/limit7 SC7 ○ ○

PC12, PC1012 Analog speed command maximum speed/limit maximum 
speed VCM ○ ○

PC13, PC1013 Analog torque command maximum output TLC ○ ○

PC14, PC1014 Analog monitor 1 output MOD1 ○ ○

PC15, PC1015 Analog monitor 2 output MOD2 ○ ○

PC16, PC1016 Electromagnetic brake sequence output MBR ○ ○

PC17, PC1017 Zero speed ZSP ○ ○

PC18, PC1018 Alarm history clear *BPS ○ ○

PC19, PC1019 Encoder output pulse selection *ENRS ○ ○

PC20, PC1020 Station number setting *SNO ○ ×

PC21, PC1021 Communication function selection *SOP ○ ×

PC22, PC1022 Function selection C-1 *COP1 ○ ○

PC23, PC1023 Function selection C-2 *COP2 ○ ○

PC24, PC1024 Function selection C-3 *COP3 ○ ○

PC25, PC1025 For manufacturer setting - × ×

PC26, PC1026 Function selection C-5 *COP5 ○ ○

PC27, PC1027 Function selection C-6 *COP6 ○ ○

PC28 to PC29, 
PC1028 to PC1029 For manufacturer setting - × ×

PC30, PC1030 Acceleration time constant 2 STA2 ○ ○

PC31, PC1031 Deceleration time constant 2 STB2 ○ ○

PC32, PC1032 Command input pulse multiplication numerator 2 CMX2 ○ ○

PC33, PC1033 Command input pulse multiplication numerator 3 CMX3 ○ ○

PC34, PC1034 Command input pulse multiplication numerator 4 CMX4 ○ ○

PC35, PC1035 Internal torque limit 2 TL2 ○ ○

PC36, PC1036 Status display selection *DMD ○ ○

PC37, PC1037 Analog speed command offset/limit offset VCO ○ ○

PC38, PC1038 Analog torque command offset/limit offset TPO ○ ○

PC39, PC1039 Analog monitor 1 offset MO1 ○ ○

PC40, PC1040 Analog monitor 2 offset MO2 ○ ○
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(8) I/O setting parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD48: Writing data to the RAM of a servo amplifier
• PD1001 to PD1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PC41 to PC42, 
PC1041 to PC1042 For manufacturer setting - × ×

PC43, PC1043 Error excessive alarm detection level ERZ ○ ○

PC44 to PC 50, 
PC1044 to PC1050 For manufacturer setting - × ×

PC51, PC1051 Forced stop deceleration time constant RSBR ○ ○

PC52 to PC53, 
PC1052 to PC1053 For manufacturer setting - × ×

PC54, PC1054 Vertical axis freefall prevention compensation amount RSUP1 ○ ○

PC55 to PC59, 
PC1055 to PC1059 For manufacturer setting - × ×

PC60, PC1060 Function selection C-D *COPD ○ ○

PC61 to PC65, 
PC1061 to PC1065 For manufacturer setting - × ×

PC66, PC1066 Mark detection range+ LPSPL × ○

PC67, PC1067 Mark detection range+ LPSPH × ○

PC68, PC1068 Mark detection range- LPSNL × ○

PC69, PC1069 Mark detection range- LPSNH × ○

PC70, PC1070 Modbus-RTU Communication station number setting *SNOM × ○

PC71, PC1071 Function selection C-F *COPF × ○

PC72, PC1072 Function selection C-G *COPG × ○

PC73, PC1073 Error excessive warning level ERW × ○

PC74 to PC80, 
PC1074 to PC1080 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PD1, PD1001 Input signal automatic on selection 1 *DIA1 ○ ○

PD2, PD1002 For manufacturer setting - × ×

PD3, PD1003 Input device selection 1L *DI1L ○ ○

PD4, PD1004 Input device selection 1H *DI1H ○ ○

PD5, PD1005 Input device selection 2L *DI2L ○ ×

PD6, PD1006 Input device selection 2H *DI2H ○ ×

PD7, PD1007 Input device selection 3L *DI3L ○ ×

PD8, PD1008 Input device selection 3H *DI3H ○ ×

PD9, PD1009 Input device selection 4L *DI4L ○ ×

PD10, PD1010 Input device selection 4H *DI4H ○ ×

PD11, PD1011 Input device selection 5L *DI5L ○ ○

PD12, PD1012 Input device selection 5H *DI5H ○ ○

PD13, PD1013 Input device selection 6L *DI6L ○ ○

PD14, PD1014 Input device selection 6H *DI6H ○ ○

PD15 to PD16, 
PD1015 to PD1016 For manufacturer setting - × ×

PD17, PD1017 Input device selection 8L *DI8L ○ ○

PD18, PD1018 Input device selection 8H *DI8H ○ ○
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(9) Linear servo motor/DD motor setting parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PL1 to PL48: Writing data to the RAM of a servo amplifier
• PL1001 to PL1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PD19, PD1019 Input device selection 9L *DI9L ○ ○

PD20, PD1020 Input device selection 9H *DI9H ○ ○

PD21, PD1021 Input device selection 10L *DI10L ○ ×

PD22, PD1022 Input device selection 10H *DI10H ○ ×

PD23, PD1023 Output device selection 1 *DO1 ○ ×

PD24, PD1024 Output device selection 2 *DO2 ○ ○

PD25, PD1025 Output device selection 3 *DO3 ○ ○

PD26, PD1026 Output device selection 4 *DO4 ○ ×

PD27, PD1027 For manufacturer setting - × ×

PD28, PD1028 Output device selection 6 *DO6 ○ ○

PD29, PD1029 Input filter setting *DIF ○ ○

PD30, PD1030 Function selection D-1 *DOP1 ○ ○

PD31, PD1031 For manufacturer setting - × ×

PD32, PD1032 Function selection D-3 *DOP3 ○ ○

PD33, PD1033 For manufacturer setting - × ×

PD34, PD1034 Function selection D-5 *DOP5 ○ ○

PD35 to PD40, 
PD1035 to PD1040 For manufacturer setting - × ×

PD41, PD1041 Input signal automatic on selection 3 *DIA3 × ○

PD42, PD1042 Input signal automatic on selection 4 *DIA4 × ○

PD43, PD1043 Input device selection 11L *DI11L × ○

PD44, PD1044 Input device selection 11H *DI11H × ○

PD45, PD1045 Input device selection 12L *DI12L × ○

PD46, PD1046 Input device selection 12H *DI12H × ○

PD47 to PD48, 
PD1047 to PD1048 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PL1, PL1001 Linear servo motor/DD motor function selection 1 *LIT1 ○ ×

PL2, PL1002 Linear encoder resolution - Numerator *LIM ○ ×

PL3, PL1003 Linear encoder resolution - Denominator *LID ○ ×

PL4, PL1004 Linear servo motor/DD motor function selection 2 *LIT2 ○ ×

PL5, PL1005 Position deviation error detection level LB1 ○ ×

PL6, PL1006 Speed deviation error detection level LB2 ○ ×

PL7, PL1007 Torque/thrust deviation error detection level LB3 ○ ×

PL8, PL1008 Linear servo motor/DD motor function selection 3 *LIT3 ○ ×

PL9, PL1009 Magnetic pole detection voltage level LPWM ○ ×

PL10 to PL16, 
PL1010 to PL1016 For manufacturer setting - × ×

PL17, PL1017 Magnetic pole detection - Minute position detection method - 
Function selection LTSTS ○ ×

PL18, PL1018 Magnetic pole detection - Minute position detection method - 
Identification signal amplitude IDLV ○ ×
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(10)Status display ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

(11)Alarm (MELSERVO-J3-*A compatible) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

PL19 to PL48, 
PL1019 to PL1048 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

ST0 Cumulative feedback pulses - ○ ○

ST1 Servo motor speed - ○ ○

ST2 Droop pulses - ○ ○

ST3 Cumulative command pulses - ○ ○

ST4 Command pulse frequency - ○ ○

ST5 Analog speed command voltage/limit voltage - ○ ○

ST6 Analog torque command voltage/limit voltage - ○ ○

ST7 Regenerative load ratio - ○ ○

ST8 Effective load ratio - ○ ○

ST9 Peak load ratio - ○ ○

ST10 Instantaneous torque - ○ ○

ST11 Within one-revolution position (1 pulse unit) - ○ ○

ST12 ABS counter - ○ ○

ST13 Load inertia moment ratio - ○ ○

ST14 Bus voltage - ○ ○

ST15 to ST31 For manufacturer setting - × ×

ST32 Internal temperature of encoder - ○ ○

ST33 Settling time - ○ ○

ST34 Oscillation detection frequency - ○ ○

ST35 Number of tough drive operations - ○ ○

ST36 to ST39 For manufacturer setting - × ×

ST40 Unit power consumption 1 (increment of 1 W) - ○ ○

ST41 Unit total power consumption 1 (increment of 1 Wh) - ○ ○

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

AL0 Current alarm number - ○ ○

AL1 Detailed data of current alarms - ○ ×

AL11 Servo status when alarm occurs Cumulative feedback pulses - ○ ○

AL12 Servo status when alarm occurs Servo motor speed - ○ ○

AL13 Servo status when alarm occurs Droop pulses - ○ ○

AL14 Servo status when alarm occurs cumulative command pulses - ○ ○

AL15 Servo status when alarm occurs command pulse frequency - ○ ○

AL16 Servo status(alarm) analog speed command voltage/limit 
voltage - ○ ○

AL17 Servo status(alarm) analog torque command voltage/limit 
voltage - ○ ○

AL18 Servo status when alarm occurs regenerative load ratio - ○ ○

AL19 Servo status when alarm occurs effective load ratio - ○ ○

AL20 Servo status when alarm occurs peak load ratio - ○ ○

AL21 Servo status when alarm occurs Instantaneous torque - ○ ○
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(12)Extension setting No.2 parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PE1 to PE64: Writing data to the RAM of a servo amplifier
• PE1001 to PE1064: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

AL22 Servo status(alarm) Within one-revolution position(1 pulse 
unit) - ○ ○

AL23 Servo status when alarm occurs ABS counter - ○ ○

AL24 Servo status when alarm occurs load inertia moment ratio - ○ ○

AL25 Servo status when alarm occurs Bus voltage - ○ ○

AL200 Alarm number from alarm history most recent alarm - ○ ○

AL201 Alarm number from alarm history first alarm in past - ○ ○

AL202 Alarm number from alarm history second alarm in past - ○ ○

AL203 Alarm number from alarm history third alarm in past - ○ ○

AL204 Alarm number from alarm history fourth alarm in past - ○ ○

AL205 Alarm number from alarm history fifth alarm in past - ○ ○

AL210 Alarm occurrence time in alarm history most recent alarm - ○ ○

AL211 Alarm occurrence time in alarm history first alarm in past - ○ ○

AL212 Alarm occurrence time in alarm history second alarm in past - ○ ○

AL213 Alarm occurrence time in alarm history third alarm in past - ○ ○

AL214 Alarm occurrence time in alarm history fourth alarm in past - ○ ○

AL215 Alarm occurrence time in alarm history fifth alarm in past - ○ ○

AL230 Detailed alarm from alarm history most recent alarm - ○ ×

AL231 Detailed alarm from alarm history first alarm in past - ○ ×

AL232 Detailed alarm from alarm history second alarm in past - ○ ×

AL233 Detailed alarm from alarm history third alarm in past - ○ ×

AL234 Detailed alarm from alarm history fourth alarm in past - ○ ×

AL235 Detailed alarm from alarm history fifth alarm in past - ○ ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PE1 to PE40, 
PE1001 to PE1040 For manufacturer setting - × ×

PE41, PE1041 Function selection E-3 EOP3 ○ ○

PE42 to PE43, 
PE1042 to PE1043 For manufacturer setting - × ×

PE44, PE1044 Lost motion compensation positive-side compensation value 
selection LMCP × ○

PE45, PE1045 Lost motion compensation negative-side compensation value 
selection LMCN × ○

PE46, PE1046 Lost motion filter setting LMFLT × ○

PE47, PE1047 Torque offset TOF × ○

PE48, PE1048 Lost motion compensation function selection *LMOP × ○

PE49, PE1049 Lost motion compensation timing LMCD × ○

PE50, PE1050 Lost motion compensation non-sensitive band LMCT × ○

PE51 to PE64, 
PE1051 to PE1064 For manufacturer setting - × ×
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(13)Extension setting No.3 parameter ([MELSERVO-J4-*A, -JE-*A])
Use an appropriate device according to the write destination of the servo amplifier.

• PF1 to PF48: Writing data to the RAM of a servo amplifier
• PF1001 to PF1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

(14)Alarm (MELSERVO-J4-*A extended) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

PF1 to PF8, PF1001 
to PF1008 For manufacturer setting - × ×

PF9, PF1009 Function selection F-5 *FOP5 ○ ○

PF10 to PF14, 
PF1010 to PF1014 For manufacturer setting - × ×

PF15, PF1015 Electronic dynamic brake operating time DBT ○ ×

PF16 to PF20, 
PF1016 to PF1020 For manufacturer setting - × ×

PF21, PF1021 Drive recorder switching time setting DRT ○ ○

PF22, PF1022 For manufacturer setting - × ×

PF23, PF1023 Vibration tough drive - Oscillation detection level OSCL1 ○ ○

PF24, PF1024 Vibration tough drive function selection OSCL2 ○ ○

PF25, PF1025 Instantaneous power failure tough drive - Detection time CVAT ○ ○

PF26 to PF30, 
PF1026 to PF1030 For manufacturer setting - × ×

PF31, PF1031 Machine diagnosis function - Friction judgment speed FRIC ○ ○

PF32 to PF44, 
PF1032 to PF1044 For manufacturer setting - × ×

PF45, PF1045 Function selection F-12 - × ○

PF46, PF1046 Modbus-RTU comm. - Communication time-out time - × ○

PF47 to PF48, 
PF1047 to PF1048 For manufacturer setting - × ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

ALM0 Current alarm number - ○ ○

ALM1 Detailed data of current alarms - ○ ×

ALM11 Servo status(alarm) Cumulative feedback pulses - ○ ○

ALM12 Servo status(alarm) Servo motor speed - ○ ○

ALM13 Servo status(alarm) Droop pulses - ○ ○

ALM14 Servo status(alarm) Cumulative command pulses - ○ ○

ALM15 Servo status(alarm) Command pulse frequency - ○ ○

ALM16 Servo status(alarm) analog speed command voltage/limit 
voltage - ○ ○

ALM17 Servo status(alarm) analog torque command voltage/limit 
voltage - ○ ○

ALM18 Servo status(alarm) Regenerative load ratio - ○ ○

ALM19 Servo status(alarm) Effective load ratio - ○ ○

ALM20 Servo status(alarm) Peak load ratio - ○ ○

ALM21 Servo status(alarm) Instantaneous torque - ○ ○

ALM22 Servo status(alarm) Within one-revolution position(1 pulse 
unit) - ○ ○

ALM23 Servo status(alarm) ABS counter - ○ ○
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ALM24 Servo status(alarm) Load inertia moment ratio - ○ ○

ALM25 Servo status(alarm) Bus voltage - ○ ○

ALM26 to ALM42 For manufacturer setting - × ×

ALM43 Servo status(alarm) Internal temperature of encoder - ○ ○

ALM44 Servo status(alarm) Setting time - ○ ○

ALM45 Servo status(alarm) Oscillation detection frequency - ○ ○

ALM46 Servo status(alarm) Number of tough drives - ○ ○

ALM47 to ALM50 For manufacturer setting - × ×

ALM51 Servo status(alarm) Unit power consumption 1 (increment of 1 
W) - ○ ○

ALM52 Servo status(alarm) Unit total power consumption 1 (increment 
of 1 Wh) - ○ ○

ALM200 Alarm number from Alarm History most recent alarm - ○ ○

ALM201 Alarm number from Alarm History 1st alarm in past - ○ ○

ALM202 Alarm number from Alarm History 2nd alarm in past - ○ ○

ALM203 Alarm number from Alarm History 3rd alarm in past - ○ ○

ALM204 Alarm number from Alarm History 4th alarm in past - ○ ○

ALM205 Alarm number from Alarm History 5th alarm in past - ○ ○

ALM206 Alarm number from Alarm History 6th alarm in past - ○ ○

ALM207 Alarm number from Alarm History 7th alarm in past - ○ ○

ALM208 Alarm number from Alarm History 8th alarm in past - ○ ○

ALM209 Alarm number from Alarm History 9th alarm in past - ○ ○

ALM210 Alarm number from Alarm History 10th alarm in past - ○ ○

ALM211 Alarm number from Alarm History 11th alarm in past - ○ ○

ALM212 Alarm number from Alarm History 12th alarm in past - ○ ○

ALM213 Alarm number from Alarm History 13th alarm in past - ○ ○

ALM214 Alarm number from Alarm History 14th alarm in past - ○ ○

ALM215 Alarm number from Alarm History 15th alarm in past - ○ ○

ALM220 Alarm occurrence time in alarm history most recent alarm - ○ ○

ALM221 Alarm occurrence time in alarm history 1st alarm in past - ○ ○

ALM222 Alarm occurrence time in alarm history 2nd alarm in past - ○ ○

ALM223 Alarm occurrence time in alarm history 3rd alarm in past - ○ ○

ALM224 Alarm occurrence time in alarm history 4th alarm in past - ○ ○

ALM225 Alarm occurrence time in alarm history 5th alarm in past - ○ ○

ALM226 Alarm occurrence time in alarm history 6th alarm in past - ○ ○

ALM227 Alarm occurrence time in alarm history 7th alarm in past - ○ ○

ALM228 Alarm occurrence time in alarm history 8th alarm in past - ○ ○

ALM229 Alarm occurrence time in alarm history 9th alarm in past - ○ ○

ALM230 Alarm occurrence time in alarm history 10th alarm in past - ○ ○

ALM231 Alarm occurrence time in alarm history 11th alarm in past - ○ ○

ALM232 Alarm occurrence time in alarm history 12th alarm in past - ○ ○

ALM233 Alarm occurrence time in alarm history 13th alarm in past - ○ ○

ALM234 Alarm occurrence time in alarm history 14th alarm in past - ○ ○

ALM235 Alarm occurrence time in alarm history 15th alarm in past - ○ ○

ALM240 Detailed alarm from Alarm History most recent alarm - ○ ×

ALM241 Detailed alarm from Alarm History 1st alarm in past - ○ ×

ALM242 Detailed alarm from Alarm History 2nd alarm in past - ○ ×

ALM243 Detailed alarm from Alarm History 3rd alarm in past - ○ ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A
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(15)Machine diagnosis data ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

(16)One-touch tuning data ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

(17)External input signal in MR-J4-□A ([MELSERVO-J4-*A, -JE-*A])

ALM244 Detailed alarm from Alarm History 4th alarm in past - ○ ×

ALM245 Detailed alarm from Alarm History 5th alarm in past - ○ ×

ALM246 Detailed alarm from Alarm History 6th alarm in past - ○ ×

ALM247 Detailed alarm from Alarm History 7th alarm in past - ○ ×

ALM248 Detailed alarm from Alarm History 8th alarm in past - ○ ×

ALM249 Detailed alarm from Alarm History 9th alarm in past - ○ ×

ALM250 Detailed alarm from Alarm History 10th alarm in past - ○ ×

ALM251 Detailed alarm from Alarm History 11th alarm in past - ○ ×

ALM252 Detailed alarm from Alarm History 12th alarm in past - ○ ×

ALM253 Detailed alarm from Alarm History 13th alarm in past - ○ ×

ALM254 Detailed alarm from Alarm History 14th alarm in past - ○ ×

ALM255 Detailed alarm from Alarm History 15th alarm in past - ○ ×

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

MD0 Machine diagnosis data station number - ○ ○

MD1 Machine diagnosis data shift judgment (test mode) - ○ ○

MD2 Machine diagnosis data status - ○ ○

MD3 Machine diagnosis data coulomb friction torque in positive 
direction - ○ ○

MD4 Machine diagnosis data friction torque at rated speed in 
positive direction - ○ ○

MD5 Machine diagnosis data coulomb friction torque in negative 
direction - ○ ○

MD6 Machine diagnosis data friction torque at rated speed in 
negative direction - ○ ○

MD7 Machine diagnosis data oscillation frequency (motor is 
stopped) - ○ ○

MD8 Machine diagnosis data vibration level (motor is stopped) - ○ ○

MD9 Machine diagnosis data oscillation frequency (motor is 
operating) - ○ ○

MD10 Machine diagnosis data vibration level (motor is operating) - ○ ○

MD11 Machine diagnosis data, rated speed at forward or reverse 
rotation torque - ○ ○

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

OTS0 One-touch tuning status confirmation - ○ ○

OTS1 Error code list - ○ ○

OTS2 Settling time - ○ ○

OTS3 Overshoot amount - ○ ○

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J4-_A_(-RJ)/MR-J4-03A6(-RJ) SERVO AMPLIFIER INSTRUCTION 
MANUAL

DI1 External input pin statuses -

DI2 Statuses of input devices switched on through 
communication -
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(18)External input signal in MR-JE-□A ([MELSERVO-J4-*A, -JE-*A])

(19)External output signal in MR-J4-□A ([MELSERVO-J4-*A, -JE-*A])

(20)External output signal in MR-JE-□A ([MELSERVO-J4-*A, -JE-*A])

(21)Life diagnosis ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

(22)Input signal for test operation (for test operation) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the input signal for test operation (for test operation), note the following.

(23)Forced output of signal pin (for test operation) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the forced output of signal pin (for test operation), note the following.

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - System information

DI1 External input pin statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-JE-_A SERVO AMPLIFIER INSTRUCTION MANUAL

DI2 Statuses of input devices switched on through 
communication - System information

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J4-_A_(-RJ)/MR-J4-03A6(-RJ) SERVO AMPLIFIER INSTRUCTION 
MANUAL

DO1 External output pin statuses -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-JE-_A SERVO AMPLIFIER INSTRUCTION MANUAL

DO1 External output pin statuses - System information

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

ALD0 Cumulative power-on time - ○ ○

ALD1 Number of inrush current switching times - ○ ○

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

TMI0 Input signal for test operation - ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

TMO0 Forced output of signal pin - ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(24)Set data (for test operation) ([MELSERVO-J4-*A, -JE-*A])
○: Available
×: Not available

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J4-*A, -JE-*A])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol MR-J4-□A MR-JE-□A

TMD0 Writes the speed (test mode) - ○ ○

TMD1 Writes the acceleration/deceleration time constant (test mode) - ○ ○

TMD3 Writes the moving distance (test mode) - ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.20 [MELSERVO-J4-*A-RJ]

■1 Monitoring-supported bit devices ([MELSERVO-J4-*A-RJ])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.20 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A-RJ])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.20 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A-RJ])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J4-*A-RJ])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J4-*A-RJ])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J4-*A-RJ])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J4-*A-RJ])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A-RJ])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J4-*A-RJ])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A-RJ])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal 0 to 2, 4 to 5 × ×

TMB Instruction demand (for test 
operation) Decimal 1 to 6 × ×

OTI One-touch tuning instruction Decimal 0 to 5 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-
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➟12.3.20 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A-RJ])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.20 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic parameter Decimal
1 to 32
1001 to 1032

○ ×

PB Gain filter parameter Decimal
1 to 64
1001 to 1064

○ ×

PC Extension setting parameter Decimal
1 to 80
1001 to 1080

○ ×

PD I/O setting parameter Decimal
1 to 48
1001 to 1048

○ ×

PO Option setting parameter Decimal
1 to 32
1001 to 1032

○ ×

PL Linear servo motor/DD motor 
setting parameter Decimal

1 to 48
1001 to 1048

○ ×

PT Positioning control parameter Decimal
1 to 48
1001 to 1048

○ ×

ST Status display Decimal 0 to 48 ○ ×

AL Alarm (current alarm, J3A 
compatible) Decimal

0 to 1
11 to 25

○ ×

AL Alarm (alarm history, J3A 
compatible) Decimal

200 to 205
210 to 215
230 to 235

○ ×

PE Extension setting No.2 parameter Decimal
1 to 64
1001 to 1064

○ ×

PF Extension setting No.3 parameter Decimal
1 to 48
1001 to 1048

○ ×

ALM Alarm (current alarm, J4A extend) Decimal
0 to 1
11 to 59

○ ×

ALM Alarm (alarm history, J4A extend) Decimal
200 to 215
220 to 235
240 to 255

○ ×

POS Point table (position) Decimal
1 to 255
1001 to 1255

○ ×

SPD Point table (speed) Decimal
1 to 255
1001 to 1255

○ ×

ACT Point table (acceleration time 
constant) Decimal

1 to 255
1001 to 1255

○ ×

DCT Point table (deceleration time 
constant) Decimal

1 to 255
1001 to 1255

○ ×

DWL Point table (dwell) Decimal
1 to 255
1001 to 1255

○ ×

AUX Point table (auxiliary function) Decimal
1 to 255
1001 to 1255

○ ×

MCD*2 Point table (M code) Decimal
1 to 255
1001 to 1255

○ ×

MD Machine diagnosis data Decimal 0 to 11 × ×

OTS One-touch tuning data Decimal 0 to 3 × ×

DI External input signal Decimal 0 to 6 × ×

DO External output signal Decimal 0 to 4 × ×
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*2 MCD cannot be used as a real number.

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J4-*A-RJ])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for DI0 to DI3.

■5 Monitoring-supported double-word devices ([MELSERVO-J4-*A-RJ])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.20 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A-RJ])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.20 ■7 Virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])
○: Available
×: Not available

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PO R/W R/W -/- -/-

PL R/W R/W -/- -/-

PT R/W R/W -/- -/-

ST R/- R/- -/- -/-

AL R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MCD R/W R/W -/- -/-

MD R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LD Current position latch data Decimal 0 to 1 × ×

RR*2 Value of the general-purpose 
register (Rx) Decimal

1 to 4
1001 to 1004

× ×

RD Value of the general-purpose 
register (Dx) Decimal 1 to 4 × ×

ALD Life diagnosis Decimal 0 to 1 × ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Use the integer number when writing parameters to Rx.

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J4-*A-RJ])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

TMI Input signal for test operation (for 
test operation) Decimal 0 to 2 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to1, 3 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LD -/- R/- -/- -/-

RR -/- R/W -/- -/-

RD -/- R/W -/- -/-

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J4-*A-RJ])

OM ➟(2) Operation mode selection ([MELSERVO-J4-*A-RJ])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J4-*A-RJ])

OTI ➟(4) One-touch tuning instruction ([MELSERVO-J4-*A-RJ])

PA ➟(5) Basic parameter ([MELSERVO-J4-*A-RJ])

PB ➟(6) Gain filter parameter ([MELSERVO-J4-*A-RJ])

PC ➟(7) Extension setting parameter ([MELSERVO-J4-*A-RJ])

PD ➟(8) I/O setting parameter ([MELSERVO-J4-*A-RJ])

PO ➟(9) Option setting parameter ([MELSERVO-J4-*A-RJ])

PL ➟(10) Linear servo motor/DD motor setting parameter ([MELSERVO-J4-*A-RJ])

PT ➟(11) Positioning control parameter ([MELSERVO-J4-*A-RJ])

ST ➟(12) Status display ([MELSERVO-J4-*A-RJ])

AL ➟(13) Alarm (MELSERVO-J3-*A compatible) ([MELSERVO-J4-*A-RJ])

PE ➟(14) Extension setting No.2 parameter ([MELSERVO-J4-*A-RJ])

PF ➟(15) Extension setting No.3 parameter ([MELSERVO-J4-*A-RJ])

ALM ➟(16) Alarm (MELSERVO-J4-*A extended) ([MELSERVO-J4-*A-RJ])

POS ➟(17) Point table (position) ([MELSERVO-J4-*A-RJ])
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(1) Servo amplifier request ([MELSERVO-J4-*A-RJ])

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J4-*A-RJ])

When using the operation mode selection, note the following.

SPD ➟(18) Point table (speed) ([MELSERVO-J4-*A-RJ])

ACT ➟(19) Point table (acceleration time constant) ([MELSERVO-J4-*A-RJ])

DCT ➟(20) Point table (deceleration time constant) ([MELSERVO-J4-*A-RJ])

DWL ➟(21) Point table (dwell) ([MELSERVO-J4-*A-RJ])

AUX ➟(22) Point table (auxiliary function) ([MELSERVO-J4-*A-RJ])

MCD ➟(23) Point table (M code) ([MELSERVO-J4-*A-RJ])

MD ➟(24) Machine diagnosis data ([MELSERVO-J4-*A-RJ])

OTS ➟(25) One-touch tuning data ([MELSERVO-J4-*A-RJ])

DI ➟(26) External input signal ([MELSERVO-J4-*A-RJ])

DO ➟(27) External output signal ([MELSERVO-J4-*A-RJ])

LD ➟(28) Current position latch data ([MELSERVO-J4-*A-RJ])

RR ➟(29) Value of the general-purpose register (Rx) ([MELSERVO-J4-*A-RJ])

RD ➟(30) Value of the general-purpose register (Dx) ([MELSERVO-J4-*A-RJ])

ALD ➟(31) Life diagnosis ([MELSERVO-J4-*A-RJ])

TMI ➟(32) Input signal for test operation (for test operation) ([MELSERVO-J4-*A-RJ])

TMO ➟(33) Forced output of signal pin (for test operation) ([MELSERVO-J4-*A-RJ])

TMD ➟(34) Set data (for test operation) ([MELSERVO-J4-*A-RJ])

Virtual device name Reference

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM4 Output signal (DO) forced output -

OM5 Single-step feed operation -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(3) Instruction demand (for test operation) ([MELSERVO-J4-*A-RJ])

When using the instruction demand (for test operation), note the following.

(4) One-touch tuning instruction ([MELSERVO-J4-*A-RJ])

(5) Basic parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA32: Writing data to the RAM of a servo amplifier
• PA1001 to PA1032: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

TMB1 Temporary stop command -

TMB2 Test operation (positioning operation) start command -

TMB3 Forward rotation direction -

TMB4 Reverse rotation direction -

TMB5 Restart for remaining distance -

TMB6 Remaining distance clear -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OTI0 One-touch tuning start command (Basic mode) -

OTI1 One-touch tuning start command (High mode) -

OTI2 One-touch tuning start command (Low mode) -

OTI3 One-touch tuning stop command -

OTI4 Return to initial value -

OTI5 Return to value before adjustment -

Virtual device name Name Symbol

PA1, PA1001 Operation mode *STY

PA2, PA1002 Regenerative brake option *REG

PA3, PA1003 Absolute position detection system *ABS

PA4, PA1004 Function selection A-1 *AOP1

PA5, PA1005 Number of command input pulses per revolution *FBP

PA6, PA1006 Electronic gear numerator (command pulse multiplication numerator)/number of gear teeth on 
machine side *CMX

PA7, PA1007 Electronic gear denominator (command pulse multiplication denominator)/number of gear teeth 
on servo motor side *CDV

PA8, PA1008 Auto tuning mode ATU

PA9, PA1009 Auto tuning response RSP

PA10, PA1010 In-position range INP

PA11, PA1011 Forward rotation torque limit/positive direction thrust limit TLP

PA12, PA1012 Reverse rotation torque limit/negative direction thrust limit TLN

PA13, PA1013 Command pulse input form *PLSS

PA14, PA1014 Rotation direction selection/travel direction selection *POL

PA15, PA1015 Encoder output pulses *ENR

PA16, PA1016 Encoder output pulses 2 *ENR2

PA17, PA1017 Servo motor series setting *MSR

PA18, PA1018 Servo motor type setting *MTY

PA19, PA1019 Parameter block *BLK

PA20, PA1020 Tough drive setting *TDS
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(6) Gain filter parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB64: Writing data to the RAM of a servo amplifier
• PB1001 to PB1064: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PA21, PA1021 Function selection A-3 *AOP3

PA22, PA1022 Position control composition selection *PCS

PA23, PA1023 Drive recorder arbitrary alarm trigger setting DRAT

PA24, PA1024 Function selection A-4 AOP4

PA25, PA1025 One-touch tuning - Overshoot permissible level OTHOV

PA26, PA1026 Function selection A-5 *AOP5

PA27 to PA32, PA1027 to 
PA1032 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT

PB2, PB1002 Vibration suppression control tuning mode (advanced vibration suppression control II) VRFT

PB3, PB1003 Position command acceleration/deceleration time constant (position smoothing) PST

PB4, PB1004 Feed forward gain FFC

PB5, PB1005 For manufacturer setting -

PB6, PB1006 Load to motor inertia ratio/load to motor mass ratio GD2

PB7, PB1007 Model control gain PG1

PB8, PB1008 Position control gain PG2

PB9, PB1009 Speed control gain VG2

PB10, PB1010 Speed integral compensation VIC

PB11, PB1011 Speed differential compensation VDC

PB12, PB1012 Overshoot amount compensation OVA

PB13, PB1013 Machine resonance suppression filter 1 NH1

PB14, PB1014 Notch shape selection 1 NHQ1

PB15, PB1015 Machine resonance suppression filter 2 NH2

PB16, PB1016 Notch shape selection 2 NHQ2

PB17, PB1017 Shaft resonance suppression filter NHF

PB18, PB1018 Low-pass filter setting LPF

PB19, PB1019 Vibration suppression control 1 - Vibration frequency VRF11

PB20, PB1020 Vibration suppression control 1 - Resonance frequency VRF12

PB21, PB1021 Vibration suppression control 1 - Vibration frequency damping VRF13

PB22, PB1022 Vibration suppression control 1 - Resonance frequency damping VRF14

PB23, PB1023 Low-pass filter setting VFBF

PB24, PB1024 Slight vibration suppression control *MVS

PB25, PB1025 Function selection B-1 *BOP1

PB26, PB1026 Gain switching function *CDP

PB27, PB1027 Gain switching condition CDL

PB28, PB1028 Gain switching time constant CDT

PB29, PB1029 Load to motor inertia ratio/load to motor mass ratio after gain switching GD2B

PB30, PB1030 Position loop gain after gain switching PG2B

PB31, PB1031 Speed loop gain after gain switching VG2B

PB32, PB1032 Speed integral compensation after gain switching VICB

PB33, PB1033 Vibration suppression control 1 - Vibration frequency after gain switching VRF1B
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(7) Extension setting parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC80: Writing data to the RAM of a servo amplifier
• PC1001 to PC1080: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PB34, PB1034 Vibration suppression control 1 - Resonance frequency after gain switching VRF2B

PB35, PB1035 Vibration suppression control 1 - Vibration frequency damping after gain switching VRF3B

PB36, PB1036 Vibration suppression control 1 - Resonance frequency damping after gain switching VRF4B

PB37 to PB44, PB1037 to 
PB1044 For manufacturer setting -

PB45, PB1045 Command notch filter CNHF

PB46, PB1046 Machine resonance suppression filter 3 NH3

PB47, PB1047 Notch shape selection 3 NHQ3

PB48, PB1048 Machine resonance suppression filter 4 NH4

PB49, PB1049 Notch shape selection 4 NHQ4

PB50, PB1050 Machine resonance suppression filter 5 NH5

PB51, PB1051 Notch shape selection 5 NHQ5

PB52, PB1052 Vibration suppression control 2 - Vibration frequency VRF21

PB53, PB1053 Vibration suppression control 2 - Resonance frequency VRF22

PB54, PB1054 Vibration suppression control 2 - Vibration frequency damping VRF23

PB55, PB1055 Vibration suppression control 2 - Resonance frequency damping VRF24

PB56, PB1056 Vibration suppression control 2 - Vibration frequency after gain switching VRF21B

PB57, PB1057 Vibration suppression control 2 - Resonance frequency after gain switching VRF22B

PB58, PB1058 Vibration suppression control 2 - Vibration frequency damping after gain switching VRF23B

PB59, PB1059 Vibration suppression control 2 - Resonance frequency damping after gain switching VRF24B

PB60, PB1060 Model loop gain after gain switching PG1B

PB61 to PB64, PB1061 to 
PB1064 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

PC1, PC1001 JOG operation acceleration time constant/acceleration time constant 1 STA

PC2, PC1002 JOG operation deceleration time constant/deceleration time constant 1 STB

PC3, PC1003 S-pattern acceleration/deceleration time constant *STC

PC4, PC1004 Torque command time constant/thrust command time constant TQC

PC5, PC1005 Automatic operation speed 1 SC1

PC6, PC1006 Automatic operation speed 2 SC2

PC7, PC1007 Manual operation speed 1 SC3

PC8, PC1008 Internal speed command4/limit4 SC4

PC9, PC1009 Internal speed command5/limit5 SC5

PC10, PC1010 Internal speed command6/limit6 SC6

PC11, PC1011 Internal speed command7/limit7 SC7

PC12, PC1012 Analog speed command maximum speed/limit maximum speed VCM

PC13, PC1013 Analog torque command maximum output TLC

PC14, PC1014 Analog monitor 1 output MOD1

PC15, PC1015 Analog monitor 2 output MOD2

PC16, PC1016 Electromagnetic brake sequence output MBR

PC17, PC1017 Zero speed ZSP

PC18, PC1018 Alarm history clear *BPS
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(8) I/O setting parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

PC19, PC1019 Encoder output pulse selection *ENRS

PC20, PC1020 Station number setting *SNO

PC21, PC1021 RS-422 communication function selection *SOP

PC22, PC1022 Function selection C-1 *COP1

PC23, PC1023 Function selection C-2 *COP2

PC24, PC1024 Function selection C-3 *COP3

PC25, PC1025 For manufacturer setting -

PC26, PC1026 Function selection C-5 *COP5

PC27, PC1027 Function selection C-6 *COP6

PC28, PC1028 Function selection C-7 *COP7

PC29, PC1029 For manufacturer setting -

PC30, PC1030 Home position return acceleration time constant/acceleration time constant 2 STA2

PC31, PC1031 Home position return deceleration time constant/deceleration time constant 2 STB2

PC32, PC1032 Command input pulse multiplication numerator 2 CMX2

PC33, PC1033 Command input pulse multiplication numerator 3 CMX3

PC34, PC1034 Command input pulse multiplication numerator 4 CMX4

PC35, PC1035 Internal torque limit 2/internal thrust limit 2 TL2

PC36, PC1036 Status display selection *DMD

PC37, PC1037 Analog override offset VCO

PC38, PC1038 Analog torque command offset/limit offset TPO

PC39, PC1039 Analog monitor 1 offset MO1

PC40, PC1040 Analog monitor 2 offset MO2

PC41 to PC42, PC1041 to 
PC1042 For manufacturer setting -

PC43, PC1043 Error excessive alarm detection level ERZ

PC44, PC1044 Function selection C-9 *COP9

PC45, PC1045 Function selection C-A *COPA

PC46 to PC50, PC1046 to 
PC1050 For manufacturer setting -

PC51, PC1051 Forced stop deceleration time constant RSBR

PC52 to PC53, PC1052 to 
PC1053 For manufacturer setting -

PC54, PC1054 Vertical axis freefall prevention compensation amount RSUP1

PC55 to PC59, PC1055 to 
PC1059 For manufacturer setting -

PC60, PC1060 Function selection C-D *COPD

PC61 to PC65, PC1061 to 
PC1065 For manufacturer setting -

PC66, PC1066 Mark detection range+(Low) LPSPL

PC67, PC1067 Mark detection range+(High) LPSPH

PC68, PC1068 Mark detection range-(Low) LPSNL

PC69, PC1069 Mark detection range-(High) LPSNH

PC70, PC1070 Modbus-RTU Communication station number setting *SNOM

PC71, PC1071 Function selection C-F *COPF

PC72, PC1072 Function selection C-G *COPG

PC73, PC1073 Error excessive warning level ERW

PC74 to PC80, PC1074 to 
PC1080 For manufacturer setting -

Virtual device name Name Symbol
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• PD1 to PD48: Writing data to the RAM of a servo amplifier
• PD1001 to PD1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

PD1, PD1001 Input signal automatic on selection 1 *DIA1

PD2, PD1002 For manufacturer setting -

PD3, PD1003 Input device selection 1L *DI1L

PD4, PD1004 Input device selection 1H *DI1H

PD5, PD1005 Input device selection 2L *DI2L

PD6, PD1006 Input device selection 2H *DI2H

PD7, PD1007 Input device selection 3L *DI3L

PD8, PD1008 Input device selection 3H *DI3H

PD9, PD1009 Input device selection 4L *DI4L

PD10, PD1010 Input device selection 4H *DI4H

PD11, PD1011 Input device selection 5L *DI5L

PD12, PD1012 Input device selection 5H *DI5H

PD13, PD1013 Input device selection 6L *DI6L

PD14, PD1014 Input device selection 6H *DI6H

PD15 to PD16, PD1015 to 
PD1016 For manufacturer setting -

PD17, PD1017 Input device selection 8L *DI8L

PD18, PD1018 Input device selection 8H *DI8H

PD19, PD1019 Input device selection 9L *DI9L

PD20, PD1020 Input device selection 9H *DI9H

PD21, PD1021 Input device selection 10L *DI10L

PD22, PD1022 Input device selection 10H *DI10H

PD23, PD1023 Output device selection 1 *DO1

PD24, PD1024 Output device selection 2 *DO2

PD25, PD1025 Output device selection 3 *DO3

PD26, PD1026 Output device selection 4 *DO4

PD27, PD1027 For manufacturer setting -

PD28, PD1028 Output device selection 6 *DO6

PD29, PD1029 Input filter setting *DIF

PD30, PD1030 Function selection D-1 *DOP1

PD31, PD1031 Function selection D-2 *DOP2

PD32, PD1032 Function selection D-3 *DOP3

PD33, PD1033 Function selection D-4 *DOP4

PD34, PD1034 Function selection D-5 *DOP5

PD35 to PD40, PD1035 to 
PD1040 For manufacturer setting -

PD41, PD1041 Input signal automatic on selection 3 *DIA3

PD42, PD1042 Input signal automatic on selection 4 *DIA4

PD43, PD1043 Input device selection 11L *DI11L

PD44, PD1044 Input device selection 11H *DI11H

PD45, PD1045 Input device selection 12L *DI12L

PD46, PD1046 Input device selection 12H *DI12H

PD47, PD1047 Output device selection 7 *DO7

PD48, PD1048 For manufacturer setting -
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(9) Option setting parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PO1 to PO32: Writing data to the RAM of a servo amplifier
• PO1001 to PO1032: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(10)Linear servo motor/DD motor setting parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PL1 to PL48: Writing data to the RAM of a servo amplifier
• PL1001 to PL1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

PO1, PO1001 For manufacturer setting -

PO2, PO1002 MR-D01 input device selection 1 *ODI1

PO3, PO1003 MR-D01 input device selection 2 *ODI2

PO4, PO1004 MR-D01 input device selection 3 *ODI3

PO5, PO1005 MR-D01 input device selection 4 *ODI4

PO6, PO1006 MR-D01 input device selection 5 *ODI5

PO7, PO1007 MR-D01 input device selection 6 *ODI6

PO8, PO1008 MR-D01 output device selection 1 *ODO1

PO9, PO1009 MR-D01 output device selection 2 *ODO2

PO10, PO1010 Function selection O-1 *OOP1

PO11, PO1011 Function selection O-2 *OOP2

PO12, PO1012 Function selection O-3 *OOP3

PO13, PO1013 MR-D01 analog monitor 1 output selection OMOD1

PO14, PO1014 MR-D01 analog monitor 2 output selection OMOD2

PO15, PO1015 MR-D01 analog monitor 1 offset OMO1

PO16, PO1016 MR-D01 analog monitor 2 offset OMO2

PO17 to PO20, PO1017 to 
PO1020 For manufacturer setting -

PO21, PO1021 MR-D01 override offset OVCO

PO22, PO1022 MR-D01 analog torque limit offset OTLO

PO23 to PO26, PO1023 to 
PO1026 For manufacturer setting -

PO27, PO1027 MR-D01 input device selection 7 *ODI7

PO28, PO1028 MR-D01 input device selection 8 *ODI8

PO29 to PO32, PO1029 to 
PO1032 For manufacturer setting -

Virtual device name Name Symbol

PL1, PL1001 Linear servo motor/DD motor function selection 1 *LIT1

PL2, PL1002 Linear encoder resolution - Numerator *LIM

PL3, PL1003 Linear encoder resolution - Denominator *LID

PL4, PL1004 Linear servo motor/DD motor function selection 2 *LIT2

PL5, PL1005 Position deviation error detection level LB1

PL6, PL1006 Speed deviation error detection level LB2

PL7, PL1007 Torque/thrust deviation error detection level LB3

PL8, PL1008 Linear servo motor/DD motor function selection 3 *LIT3

PL9, PL1009 Magnetic pole detection voltage level LPWM

PL10 to PL16, PL1010 to 
PL1016 For manufacturer setting -
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(11)Positioning control parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PT1 to PT48: Writing data to the RAM of a servo amplifier
• PT1001 to PT1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PL17, PL1017 Magnetic pole detection - Minute position detection method - Function selection LTSTS

PL18, PL1018 Magnetic pole detection - Minute position detection method - Identification signal amplitude IDLV

PL19 to PL48, PL1019 to 
PL1048 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

PT1, PT1001 Command mode selection *CTY

PT2, PT1002 Function selection T-1 *TOP1

PT3, PT1003 Feeding function selection *FTY

PT4, PT1004 Home position return type *ZTY

PT5, PT1005 Home position return speed ZRF

PT6, PT1006 Creep speed CRF

PT7, PT1007 Home position shift distance ZST

PT8, PT1008 Home position return position data *ZPS

PT9, PT1009 Moving distance after proximity dog DCT

PT10, PT1010 Stopper type home position return stopper time ZTM

PT11, PT1011 Stopper type home position return torque limit value ZTT

PT12, PT1012 Rough match output range CRP

PT13, PT1013 JOG operation JOG

PT14, PT1014 Backlash compensation *BKC

PT15, PT1015 Software limit +(Low) LMPL

PT16, PT1016 Software limit +(High) LMPH

PT17, PT1017 Software limit -(Low) LMNL

PT18, PT1018 Software limit -(High) LMNH

PT19, PT1019 Position range output address +(Low) *LPPL

PT20, PT1020 Position range output address +(High) *LPPH

PT21, PT1021 Position range output address -(Low) *LNPL

PT22, PT1022 Position range output address -(High) *LNPH

PT23, PT1023 OUT1 output setting time OUT1

PT24, PT1024 OUT2 output setting time OUT2

PT25, PT1025 OUT3 output setting time OUT3

PT26, PT1026 Function selection T-2 *TOP2

PT27, PT1027 Operation mode selection *ODM

PT28, PT1028 Number of stations per rotation *STN

PT29, PT1029 Function selection T-3 *TOP3

PT30, PT1030 Mark sensor stop movement amount (Low) MSTL

PT31, PT1031 Mark sensor stop movement amount (High) MSTH

PT32 to PT33, PT1032 to 
PT1033 For manufacturer setting -

PT34, PT1034 Point table/program default *PDEF

PT35, PT1035 Function selection T-5 *TOP5

PT36 to PT37, PT1036 to 
PT1037 For manufacturer setting -

PT38, PT1038 Function selection T-7 *TOP7
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(12)Status display ([MELSERVO-J4-*A-RJ])

PT39, PT1039 Torque limit delay time INT

PT40, PT1040 Station home position shift distance *SZS

PT41, PT1041 Home position return inhibit selection ORP

PT42, PT1042 Digital override minimum multiplication *OVM

PT43, PT1043 Digital override pitch width *OVS

PT44, PT1044 For manufacturer setting -

PT45, PT1045 Home position return type 2 *CZTY

PT46 to PT48, PT1046 to 
PT1048 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ST0 Cumulative feedback pulses -

ST1 Servo motor speed -

ST2 Droop pulses -

ST3 Cumulative command pulses -

ST4 Command pulse frequency -

ST5 Analog speed command voltage/analog speed limit voltage -

ST6 Analog torque limit voltage/analog torque command voltage -

ST7 Regenerative load ratio -

ST8 Effective load ratio -

ST9 Peak load ratio -

ST10 Instantaneous torque -

ST11 Within one-revolution position -

ST12 ABS counter -

ST13 Load inertia moment ratio -

ST14 Bus voltage -

ST15 Load-side cumulative feedback pulses -

ST16 Load-side droop pulses -

ST17 Load-side encoder information 1 -

ST18 Load-side encoder information 2 -

ST19 to ST21 For manufacturer setting -

ST22 Temperature of servo motor thermistor -

ST23 Servo motor-side cumulative feedback pulses (before gear) -

ST24 Electrical angle -

ST25 to ST29 For manufacturer setting -

ST30 Servo motor-side/load-side position deviation -

ST31 Servo motor-side/load-side speed deviation -

ST32 Internal temperature of encoder -

ST33 Setting time -

ST34 Oscillation detection frequency -

ST35 Number of tough drive operations -

ST36 to ST39 For manufacturer setting -

ST40 Unit power consumption -

ST41 Unit total power consumption -

ST42 Current position -

ST43 Command position -

ST44 Command remaining distance -
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(13)Alarm (MELSERVO-J3-*A compatible) ([MELSERVO-J4-*A-RJ])

(14)Extension setting No.2 parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PE1 to PE64: Writing data to the RAM of a servo amplifier

ST45 Point table No./program No./station position No. -

ST46 Step No. -

ST47 Analog override voltage -

ST48 Override level -

Virtual device name Name Symbol

AL0 Current alarm number -

AL1 Detailed data of current alarms -

AL11 Servo status when alarm occurs Cumulative feedback pulses -

AL12 Servo status when alarm occurs Servo motor speed -

AL13 Servo status when alarm occurs Droop pulses -

AL14 Servo status when alarm occurs cumulative command pulses -

AL15 Servo status when alarm occurs command pulse frequency -

AL16 Servo status(alarm) analog speed command voltage/limit voltage -

AL17 Servo status(alarm) analog torque command voltage/limit voltage -

AL18 Servo status when alarm occurs regenerative load ratio -

AL19 Servo status when alarm occurs effective load ratio -

AL20 Servo status when alarm occurs peak load ratio -

AL21 Servo status when alarm occurs Instantaneous torque -

AL22 Servo status(alarm) Within one-revolution position(1 pulse unit) -

AL23 Servo status when alarm occurs ABS counter -

AL24 Servo status when alarm occurs load inertia moment ratio -

AL25 Servo status when alarm occurs Bus voltage -

AL200 Alarm number from Alarm History most recent alarm -

AL201 Alarm number from Alarm History first alarm in past -

AL202 Alarm number from Alarm History second alarm in past -

AL203 Alarm number from Alarm History third alarm in past -

AL204 Alarm number from Alarm History fourth alarm in past -

AL205 Alarm number from Alarm History fifth alarm in past -

AL210 Alarm occurrence time in alarm history most recent alarm -

AL211 Alarm occurrence time in alarm history first alarm in past -

AL212 Alarm occurrence time in alarm history second alarm in past -

AL213 Alarm occurrence time in alarm history third alarm in past -

AL214 Alarm occurrence time in alarm history fourth alarm in past -

AL215 Alarm occurrence time in alarm history fifth alarm in past -

AL230 Detailed alarm from Alarm History most recent alarm -

AL231 Detailed alarm from Alarm History first alarm in past -

AL232 Detailed alarm from Alarm History second alarm in past -

AL233 Detailed alarm from Alarm History third alarm in past -

AL234 Detailed alarm from Alarm History fourth alarm in past -

AL235 Detailed alarm from Alarm History fifth alarm in past -

Virtual device name Name Symbol
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 397



• PE1001 to PE1064: Writing data to the EEPROM of a servo amplifier
For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(15)Extension setting No.3 parameter ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• PF1 to PF48: Writing data to the RAM of a servo amplifier
• PF1001 to PF1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

PE1, PE1001 Fully closed loop function selection 1 *FCT1

PE2, PE1002 For manufacturer setting -

PE3, PE1003 Fully closed loop function selection 2 *FCT2

PE4, PE1004 Fully closed loop control - Feedback pulse electronic gear 1 - Numerator *FBN

PE5, PE1005 Fully closed loop control - Feedback pulse electronic gear 1 - Denominator *FBD

PE6, PE1006 Fully closed loop control - Speed deviation error detection level BC1

PE7, PE1007 Fully closed loop control - Position deviation error detection level BC2

PE8, PE1008 Fully closed loop dual feedback filter DUF

PE9, PE1009 For manufacturer setting -

PE10, PE1010 Fully closed loop function selection 3 FCT3

PE11 to PE33, PE1011 to 
PE1033 For manufacturer setting -

PE34, PE1034 Fully closed loop control - Feedback pulse electronic gear 2 - Numerator *FBN2

PE35, PE1035 Fully closed loop control - Feedback pulse electronic gear 2 - Denominator *FBD2

PE36 to PE40, PE1036 to 
PE1040 For manufacturer setting -

PE41, PE1041 Function selection E-3 EOP3

PE42 to PE43, PE1042 to 
PE1043 For manufacturer setting -

PE44, PE1044 Lost motion compensation positive-side compensation value selection LMCP

PE45, PE1045 Lost motion compensation negative-side compensation value selection LMCN

PE46, PE1046 Lost motion filter setting LMFLT

PE47, PE1047 Torque offset TOF

PE48, PE1048 Lost motion compensation function selection *LMOP

PE49, PE1049 Lost motion compensation timing LMCD

PE50, PE1050 Lost motion compensation non-sensitive band LMCT

PE51 to PE64, PE1051 to 
PE1064 For manufacturer setting -

Virtual device name Name Symbol

PF1 to PF8, PF1001 to 
PF1008 For manufacturer setting -

PF9, PF1009 Function selection F-5 *FOP5

PF10 to PF14, PF1010 to 
PF1014 For manufacturer setting -

PF15, PF1015 Electronic dynamic brake operating time DBT

PF16 to PF17, PF1016 to 
PF1017 For manufacturer setting -

PF18, PF1018 STO diagnosis error detection time *STOD

PF19 to PF20, PF1019 to 
PF1020 For manufacturer setting -

PF21, PF1021 Drive recorder switching time setting DRT

PF22, PF1022 For manufacturer setting -

PF23, PF1023 Vibration tough drive - Oscillation detection level OSCL1
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(16)Alarm (MELSERVO-J4-*A extended) ([MELSERVO-J4-*A-RJ])

PF24, PF1024 Vibration tough drive function selection OSCL2

PF25, PF1025 SEMI-F47 function - Instantaneous power failure detection time CVAT

PF26 to PF30, PF1026 to 
PF1030 For manufacturer setting -

PF31, PF1031 Machine diagnosis function - Friction judgment speed FRIC

PF32 to PF33, PF1032 to 
PF1033 For manufacturer setting -

PF34, PF1034 RS-422 communication function selection 3 *SOP3

PF35 to PF44, PF1035 to 
PF1044 For manufacturer setting -

PF45, PF1045 Function selection F-12 *FOP12

PF46, PF1046 Modbus-RTU comm. - Communication time-out time MIC

PF47 to PF48, PF1047 to 
PF1048 For manufacturer setting -

Virtual device name Name Symbol

Virtual device name Name Symbol

ALM0 Current alarm number -

ALM1 Detailed data of current alarms -

ALM11 Servo status(alarm) Cumulative feedback pulses -

ALM12 Servo status(alarm) Servo motor speed -

ALM13 Servo status(alarm) Droop pulses -

ALM14 Servo status(alarm) cumulative command pulses -

ALM15 Servo status(alarm) command pulse frequency -

ALM16 Servo status(alarm) analog speed command voltage/limit voltage -

ALM17 Servo status(alarm) analog torque command voltage/limit voltage -

ALM18 Servo status(alarm) regenerative load ratio -

ALM19 Servo status(alarm) effective load ratio -

ALM20 Servo status(alarm) peak load ratio -

ALM21 Servo status(alarm) Instantaneous torque -

ALM22 Servo status(alarm) Within one-revolution position(1 pulse unit) -

ALM23 Servo status(alarm) ABS counter -

ALM24 Servo status(alarm) load inertia moment ratio -

ALM25 Servo status(alarm) Bus voltage -

ALM26 Servo status(alarm) Load-side cumulative feedback pulses -

ALM27 Servo status(alarm) Load-side droop pulses -

ALM28 Servo status(alarm) Load-side encoder information 1 -

ALM29 Servo status(alarm) Load-side encoder information 2 -

ALM30 to ALM32 For manufacturer setting -

ALM33 Servo status(alarm) Temperature of servo motor thermistor -

ALM34 Servo status(alarm) Servo motor-side cumulative feedback pulses (before gear) -

ALM35 Servo status(alarm) Electrical angle -

ALM36 to ALM40 For manufacturer setting -

ALM41 Servo status(alarm) Servo motor-side/load-side position deviation -

ALM42 Servo status(alarm) Servo motor-side/load-side speed deviation -

ALM43 Servo status(alarm) Internal temperature of encoder -

ALM44 Servo status(alarm) Setting time -

ALM45 Servo status(alarm) Oscillation detection frequency -

ALM46 Servo status(alarm) Number of tough drives -

ALM47 to ALM50 For manufacturer setting -
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ALM51 Servo status(alarm) Unit power consumption -

ALM52 Servo status(alarm) Unit total power consumption -

ALM53 Servo status(alarm) Current position -

ALM54 Servo status(alarm) Command position -

ALM55 Servo status(alarm) Command remaining distance -

ALM56 Servo status(alarm) Point table No./Program No./Station position No. -

ALM57 Servo status(alarm) Step No. -

ALM58 Servo status(alarm) Analog override voltage -

ALM59 Servo status(alarm) Override level -

ALM200 Alarm number from Alarm History most recent alarm -

ALM201 Alarm number from Alarm History 1st alarm in past -

ALM202 Alarm number from Alarm History 2nd alarm in past -

ALM203 Alarm number from Alarm History 3rd alarm in past -

ALM204 Alarm number from Alarm History 4th alarm in past -

ALM205 Alarm number from Alarm History 5th alarm in past -

ALM206 Alarm number from Alarm History 6th alarm in past -

ALM207 Alarm number from Alarm History 7th alarm in past -

ALM208 Alarm number from Alarm History 8th alarm in past -

ALM209 Alarm number from Alarm History 9th alarm in past -

ALM210 Alarm number from Alarm History 10th alarm in past -

ALM211 Alarm number from Alarm History 11th alarm in past -

ALM212 Alarm number from Alarm History 12th alarm in past -

ALM213 Alarm number from Alarm History 13th alarm in past -

ALM214 Alarm number from Alarm History 14th alarm in past -

ALM215 Alarm number from Alarm History 15th alarm in past -

ALM220 Alarm occurrence time in alarm history most recent alarm -

ALM221 Alarm occurrence time in alarm history 1st alarm in past -

ALM222 Alarm occurrence time in alarm history 2nd alarm in past -

ALM223 Alarm occurrence time in alarm history 3rd alarm in past -

ALM224 Alarm occurrence time in alarm history 4th alarm in past -

ALM225 Alarm occurrence time in alarm history 5th alarm in past -

ALM226 Alarm occurrence time in alarm history 6th alarm in past -

ALM227 Alarm occurrence time in alarm history 7th alarm in past -

ALM228 Alarm occurrence time in alarm history 8th alarm in past -

ALM229 Alarm occurrence time in alarm history 9th alarm in past -

ALM230 Alarm occurrence time in alarm history 10th alarm in past -

ALM231 Alarm occurrence time in alarm history 11th alarm in past -

ALM232 Alarm occurrence time in alarm history 12th alarm in past -

ALM233 Alarm occurrence time in alarm history 13th alarm in past -

ALM234 Alarm occurrence time in alarm history 14th alarm in past -

ALM235 Alarm occurrence time in alarm history 15th alarm in past -

ALM240 Detailed alarm from Alarm History most recent alarm -

ALM241 Detailed alarm from Alarm History 1st alarm in past -

ALM242 Detailed alarm from Alarm History 2nd alarm in past -

ALM243 Detailed alarm from Alarm History 3rd alarm in past -

ALM244 Detailed alarm from Alarm History 4th alarm in past -

ALM245 Detailed alarm from Alarm History 5th alarm in past -

Virtual device name Name Symbol
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(17)Point table (position) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• POS1 to POS255: Writing data to the RAM of a servo amplifier
• POS1001 to POS1255: Writing data to the EEPROM of a servo amplifier

(18)Point table (speed) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• SPD1 to SPD255: Writing data to the RAM of a servo amplifier
• SPD1001 to SPD1255: Writing data to the EEPROM of a servo amplifier

(19)Point table (acceleration time constant) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• ACT1 to ACT255: Writing data to the RAM of a servo amplifier
• ACT1001 to ACT1255: Writing data to the EEPROM of a servo amplifier

(20)Point table (deceleration time constant) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• DCT1 to DCT255: Writing data to the RAM of a servo amplifier
• DCT1001 to DCT1255: Writing data to the EEPROM of a servo amplifier

(21)Point table (dwell) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• DWL1 to DWL255: Writing data to the RAM of a servo amplifier
• DWL1001 to DWL1255: Writing data to the EEPROM of a servo amplifier

(22)Point table (auxiliary function) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• AUX1 to AUX255: Writing data to the RAM of a servo amplifier

ALM246 Detailed alarm from Alarm History 6th alarm in past -

ALM247 Detailed alarm from Alarm History 7th alarm in past -

ALM248 Detailed alarm from Alarm History 8th alarm in past -

ALM249 Detailed alarm from Alarm History 9th alarm in past -

ALM250 Detailed alarm from Alarm History 10th alarm in past -

ALM251 Detailed alarm from Alarm History 11th alarm in past -

ALM252 Detailed alarm from Alarm History 12th alarm in past -

ALM253 Detailed alarm from Alarm History 13th alarm in past -

ALM254 Detailed alarm from Alarm History 14th alarm in past -

ALM255 Detailed alarm from Alarm History 15th alarm in past -

Virtual device name Name Symbol

Virtual device name Name Symbol

POS1 to POS255, POS1001 
to POS1255 Point table/position data No. 1 to No. 255 -

Virtual device name Name Symbol

SPD1 to SPD255, SPD1001 
to SPD1255 Point table/speed data No. 1 to No. 255 -

Virtual device name Name Symbol

ACT1 to ACT255, ACT1001 
to ACT1255 Point table/acceleration time constant No. 1 to No. 255 -

Virtual device name Name Symbol

DCT1 to DCT255, DCT1001 
to DCT1255 Point table/deceleration time constant No. 1 to No. 255 -

Virtual device name Name Symbol

DWL1 to DWL255, DWL1001 
to DWL1255 Point table/dwell No. 1 to No. 255 -
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• AUX1001 to AUX1255: Writing data to the EEPROM of a servo amplifier

(23)Point table (M code) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• MCD1 to MCD255: Writing data to the RAM of a servo amplifier
• MCD1001 to MCD1255: Writing data to the EEPROM of a servo amplifier

(24)Machine diagnosis data ([MELSERVO-J4-*A-RJ])

(25)One-touch tuning data ([MELSERVO-J4-*A-RJ])

(26)External input signal ([MELSERVO-J4-*A-RJ])

(27)External output signal ([MELSERVO-J4-*A-RJ])

Virtual device name Name Symbol

AUX1 to AUX255, AUX1001 
to AUX1255 Point table/auxiliary function No. 1 to No. 255 -

Virtual device name Name Symbol

MCD1 to MCD255, MCD1001 
to MCD1255 Point table/M code No.1 to No.255 -

Virtual device name Name Symbol

MD0 Machine diagnosis data, station number -

MD1 Machine diagnosis data shift judgment (test mode) -

MD2 Machine diagnosis data status -

MD3 Machine diagnosis data coulomb friction torque in positive direction -

MD4 Machine diagnosis data friction torque at rated speed in positive direction -

MD5 Machine diagnosis data coulomb friction torque in negative direction -

MD6 Machine diagnosis data friction torque at rated speed in negative direction -

MD7 Machine diagnosis data oscillation frequency (motor is stopped) -

MD8 Machine diagnosis data vibration level (motor is stopped) -

MD9 Machine diagnosis data oscillation frequency (motor is operating) -

MD10 Machine diagnosis data vibration level (motor is operating) -

MD11 Machine diagnosis data, rated speed at forward or reverse rotation torque -

Virtual device name Name Symbol

OTS0 One-touch tuning status confirmation -

OTS1 Error code list -

OTS2 Settling time -

OTS3 Overshoot amount -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J4-_A_(-RJ)/MR-J4-03A6(-RJ) SERVO AMPLIFIER INSTRUCTION 
MANUAL

DI3 External input pin statuses -

DI4 Statuses of input devices switched on through 
communication -

For the mapping of the bits corresponding to the data to be read or written, refer 
to the following.

➟MR-J4-_A_(-RJ)/MR-J4-03A6(-RJ) SERVO AMPLIFIER INSTRUCTION 
MANUAL

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses - For the mapping of the bits corresponding to the data to be read, refer to the 
following.

➟MR-J4-_A_(-RJ)/MR-J4-03sA6(-RJ) SERVO AMPLIFIER INSTRUCTION 
MANUAL

DO4 External output pin statuses -
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(28)Current position latch data ([MELSERVO-J4-*A-RJ])

(29)Value of the general-purpose register (Rx) ([MELSERVO-J4-*A-RJ])
Use an appropriate device according to the write destination of the servo amplifier.

• RR1 to RR4: Writing data to the RAM of a servo amplifier
• RR1001 to RR1004: Writing data to the EEPROM of a servo amplifier

(30)Value of the general-purpose register (Dx) ([MELSERVO-J4-*A-RJ])

(31)Life diagnosis ([MELSERVO-J4-*A-RJ])

(32)Input signal for test operation (for test operation) ([MELSERVO-J4-*A-RJ])

When using the input signal for test operation (for test operation), note the following.

(33)Forced output of signal pin (for test operation) ([MELSERVO-J4-*A-RJ])

When using the forced output of signal pin (for test operation), note the following.

Virtual device name Name Symbol

LD0 Position data unit -

LD1 Current position latch data -

Virtual device name Name Symbol

RR1, RR1001 Value of the general-purpose register (R1) -

RR2, RR1002 Value of the general-purpose register (R2) -

RR3, RR1003 Value of the general-purpose register (R3) -

RR4, RR1004 Value of the general-purpose register (R4) -

Virtual device name Name Symbol

RD1 Value of the general-purpose register (D1) -

RD2 Value of the general-purpose register (D2) -

RD3 Value of the general-purpose register (D3) -

RD4 Value of the general-purpose register (D4) -

Virtual device name Name Symbol

ALD0 Cumulative power-on time -

ALD1 Number of inrush current switching times -

Virtual device name Name Symbol

TMI0 Input signal for test operation 1 -

TMI1 Input signal for test operation 2 -

TMI2 Input signal for test operation 3 -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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(34)Set data (for test operation) ([MELSERVO-J4-*A-RJ])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J4-*A-RJ])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.12 ■8 Precautions for virtual servo amplifier devices ([MELSERVO-J2M-P8A])

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD3 Writes the moving distance (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
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12.3.21 [MELSERVO-JE-*C]

■1 Monitoring-supported bit devices ([MELSERVO-JE-*C])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.21 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-JE-*C])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.21 ■7 Virtual servo amplifier devices ([MELSERVO-JE-*C])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-JE-*C])
The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-JE-*C])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-JE-*C])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-JE-*C])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-JE-*C])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-JE-*C])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-JE-*C])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-JE-*C])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-JE-*C])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-JE-*C])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal 0 to 6 × ×

OM Operation mode selection Decimal
0 to 2
4 to 5

× ×

TMB Instruction demand (for test 
operation) Decimal 1 to 6 × ×

OTI One-touch tuning instruction Decimal 0 to 5 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-
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➟12.3.21 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-JE-*C])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.21 ■7 Virtual servo amplifier devices ([MELSERVO-JE-*C])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([MELSERVO-JE-*C])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic setting parameter Decimal
1 to 32
1001 to 1032

○ ×

PB Gain filter parameter Decimal
1 to 64
1001 to 1064

○ ×

PC Extension setting parameter Decimal
1 to 80
1001 to 1080

○ ×

PD I/O setting parameter Decimal
1 to 48
1001 to 1048

○ ×

PT Positioning control parameters Decimal
1 to 80
1001 to 1080

○ ×

PN Network setting parameters Decimal
1 to 48
1001 to 1048

× ×

ST Status display Decimal 0 to 48 ○ ×

PE Extension setting No.2 parameter Decimal
1 to 64
1001 to 1064

○ ×

PF Extension setting No.3 parameter Decimal
1 to 48
1001 to 1048

○ ×

ALM Alarm (Current alarm) Decimal
0 to 1
11 to 59

○ ×

ALM Alarm (Alarm history) Decimal
200 to 215
220 to 235
240 to 255

○ ×

MD Machine diagnosis data Decimal 0 to 11 × ×

OTS One-touch tuning data Decimal 0 to 3 × ×

DI External input Decimal 0 to 6 × ×

DO External output Decimal 0 to 4 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PT R/W R/W -/- -/-

PN R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-
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*1 Only reading is available for DI0 to DI3.

■5 Monitoring-supported double-word devices ([MELSERVO-JE-*C])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.21 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-JE-*C])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.21 ■7 Virtual servo amplifier devices ([MELSERVO-JE-*C])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-JE-*C])
The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

ALM R/- R/- -/- -/-

MD R/- R/- -/- -/-

OTS R/- R/- -/- -/-

DI*1 R/- R/W -/- -/-

DO R/- R/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LD Current position latch data Decimal 0 to 1 × ×

RR General-purpose register (Rx) Decimal
1 to 4
1001 to 1004

× ×

RD General-purpose register (Dx) Decimal 1 to 4 × ×

ALD Life diagnosis Decimal 0 to 1 × ×

TMI Input signal for test operation (for 
test operation) Decimal 0 to 2 × ×

TMO Forced output of signal pin (for test 
operation) Decimal 0 × ×

TMD Set data (for test operation) Decimal 0 to 1, 3 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LD -/- R/- -/- -/-

RR -/- R/W -/- -/-

RD -/- R/W -/- -/-

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-
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■7 Virtual servo amplifier devices ([MELSERVO-JE-*C])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

(1) Servo amplifier request ([MELSERVO-JE-*C])

When using the servo amplifier request, note the following.

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-JE-*C])

OM ➟(2) Operation mode selection ([MELSERVO-JE-*C])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-JE-*C])

OTI ➟(4) One-touch tuning instruction ([MELSERVO-JE-*C])

PA ➟(5) Basic parameter ([MELSERVO-JE-*C])

PB ➟(6) Gain filter parameter ([MELSERVO-JE-*C])

PC ➟(7) Extension setting parameter ([MELSERVO-JE-*C])

PD ➟(8) I/O setting parameter ([MELSERVO-JE-*C])

PT ➟(9) Positioning control parameter ([MELSERVO-JE-*C])

PN ➟(10) Network setting parameter ([MELSERVO-JE-*C])

ST ➟(11) Status display ([MELSERVO-JE-*C])

PE ➟(12) Extension setting No.2 parameter ([MELSERVO-JE-*C])

PF ➟(13) Extension setting No.3 parameter ([MELSERVO-JE-*C])

ALM ➟(14) Alarm (MELSERVO-J4-*A extended) ([MELSERVO-JE-*C])

MD ➟(15) Machine diagnosis data ([MELSERVO-JE-*C])

OTS ➟(16) One-touch tuning data ([MELSERVO-JE-*C])

DI ➟(17) External input signal ([MELSERVO-JE-*C])

DO ➟(18) External output signal ([MELSERVO-JE-*C])

LD ➟(19) Current position latch data ([MELSERVO-JE-*C])

RR ➟(20) Value of the general-purpose register (Rx) ([MELSERVO-JE-*C])

RD ➟(21) Value of the general-purpose register (Dx) ([MELSERVO-JE-*C])

ALD ➟(22) Life diagnosis ([MELSERVO-JE-*C])

TMI ➟(23) Input signal for test operation (for test operation) ([MELSERVO-JE-*C])

TMO ➟(24) Forced output of signal pin (for test operation) ([MELSERVO-JE-*C])

TMD ➟(25) Set data (for test operation) ([MELSERVO-JE-*C])

Virtual device name Name Symbol

SP0 Status display data clear -

SP1 Current alarm clear -

SP2 Alarm history clear -

SP3 External input signal prohibited -

SP4 External output signal prohibited -

SP5 External input signal resumed -

SP6 External output signal resumed -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(2) Operation mode selection ([MELSERVO-JE-*C])

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-JE-*C])

When using the instruction demand (for test operation), note the following.

(4) One-touch tuning instruction ([MELSERVO-JE-*C])

(5) Basic parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA32: Writing data to the RAM of a servo amplifier
• PA1001 to PA1032: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Virtual device name Name Symbol

OM0 Normal mode (not test operation mode) -

OM1 JOG operation -

OM2 Positioning operation -

OM4 Output signal (DO) forced output -

OM5 Single-step feed operation -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

TMB1 Temporary stop command -

TMB2 Test operation (positioning operation) start command -

TMB3 Forward rotation direction -

TMB4 Reverse rotation direction -

TMB5 Restart for remaining distance -

TMB6 Remaining distance clear -

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol

OTI0 One-touch tuning start command (Basic mode) -

OTI1 One-touch tuning start command (High mode) -

OTI2 One-touch tuning start command (Low mode) -

OTI3 One-touch tuning stop command -

OTI4 Return to initial value -

OTI5 Return to value before adjustment -

Device name Name Symbol

PA1, PA1001 Operation mode *STY

PA2, PA1002 Regenerative option *REG

PA3, PA1003 Absolute position detection system *ABS

PA4, PA1004 Function selection A-1 *AOP1

PA5, PA1005 Number of command input pulses per revolution *FBP

PA6, PA1006 Electronic gear numerator CMX

PA7, PA1007 Electronic gear denominator CDV

PA8, PA1008 Auto tuning mode ATU

PA9, PA1009 Auto tuning response RSP

PA10, PA1010 In-position range INP
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(6) Gain filter parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB64: Writing data to the RAM of a servo amplifier
• PB1001 to PB1064: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PA11, PA1011 Forward rotation torque limit TLP

PA12, PA1012 Reverse rotation torque limit TLN

PA13, PA1013 Command pulse input form *PLSS

PA14, PA1014 Rotation direction selection *POL

PA15, PA1015 Encoder output pulses *ENR

PA16, PA1016 Encoder output pulses 2 *ENR2

PA17 to PA18, PA1017 to 
PA1018 For manufacturer setting -

PA19, PA1019 Parameter block *BLK

PA20, PA1020 Tough drive setting *TDS

PA21, PA1021 Function selection A-3 *AOP3

PA22, PA1022 For manufacturer setting -

PA23, PA1023 Drive recorder arbitrary alarm trigger setting DRAT

PA24, PA1024 Function selection A-4 *AOP4

PA25, PA1025 One-touch tuning - Overshoot permissible level OTHOV

PA26, PA1026 Function selection A-5 *AOP5

PA27, PA1027 For manufacturer setting -

PA28, PA1028 Function selection A-6 *AOP6

PA29 to PA32, PA1029 to 
PA1032 For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT

PB2, PB1002 Vibration suppression control tuning mode (advanced vibration suppression control II) VRFT

PB3, PB1003 Position command acceleration/deceleration time constant (position smoothing) PST

PB4, PB1004 Feed forward gain FFC

PB5, PB1005 For manufacturer setting -

PB6, PB1006 Load inertia moment ratio GD2

PB7, PB1007 Model control gain PG1

PB8, PB1008 Position control gain PG2

PB9, PB1009 Speed control gain VG2

PB10, PB1010 Speed integral compensation VIC

PB11, PB1011 Speed differential compensation VDC

PB12, PB1012 Overshoot amount compensation OVA

PB13, PB1013 Machine resonance suppression filter 1 NH1

PB14, PB1014 Notch shape selection 1 NHQ1

PB15, PB1015 Machine resonance suppression filter 2 NH2

PB16, PB1016 Notch shape selection 2 NHQ2

PB17, PB1017 Shaft resonance suppression filter NHF

PB18, PB1018 Low-pass filter setting LPF

PB19, PB1019 Vibration suppression control 1 - Vibration frequency VRF11

PB20, PB1020 Vibration suppression control 1 - Resonance frequency VRF12

PB21, PB1021 Vibration suppression control 1 - Vibration frequency damping VRF13
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(7) Extension setting parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC80: Writing data to the RAM of a servo amplifier
• PC1001 to PC1080: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PB22, PB1022 Vibration suppression control 1 - Resonance frequency damping VRF14

PB23, PB1023 Low-pass filter setting VFBF

PB24, PB1024 Slight vibration suppression control *MVS

PB25, PB1025 Function selection B-1 *BOP1

PB26, PB1026 Gain switching function *CDP

PB27, PB1027 Gain switching condition CDL

PB28, PB1028 Gain switching time constant CDT

PB29, PB1029 Load to motor inertia ratio after gain switching GD2B

PB30, PB1030 Position loop gain after gain switching PG2B

PB31, PB1031 Speed loop gain after gain switching VG2B

PB32, PB1032 Speed integral compensation after gain switching VICB

PB33, PB1033 Vibration suppression control 1 - Vibration frequency after gain switching VRF1B

PB34, PB1034 Vibration suppression control 1 - Resonance frequency after gain switching VRF2B

PB35, PB1035 Vibration suppression control 1 - Vibration frequency damping after gain switching VRF3B

PB36, PB1036 Vibration suppression control 1 - Resonance frequency damping after gain switching VRF4B

PB37 to PB44, PB1037 to 
PB1044 For manufacturer setting -

PB45, PB1045 Command notch filter CNHF

PB46, PB1046 Machine resonance suppression filter 3 NH3

PB47, PB1047 Notch shape selection 3 NHQ3

PB48, PB1048 Machine resonance suppression filter 4 NH4

PB49, PB1049 Notch shape selection 4 NHQ4

PB50, PB1050 Machine resonance suppression filter 5 NH5

PB51, PB1051 Notch shape selection 5 NHQ5

PB52, PB1052 Vibration suppression control 2 - Vibration frequency VRF21

PB53, PB1053 Vibration suppression control 2 - Resonance frequency VRF22

PB54, PB1054 Vibration suppression control 2 - Vibration frequency damping VRF23

PB55, PB1055 Vibration suppression control 2 - Resonance frequency damping VRF24

PB56, PB1056 Vibration suppression control 2 - Vibration frequency after gain switching VRF21B

PB57, PB1057 Vibration suppression control 2 - Resonance frequency after gain switching VRF22B

PB58, PB1058 Vibration suppression control 2 - Vibration frequency damping after gain switching VRF23B

PB59, PB1059 Vibration suppression control 2 - Resonance frequency damping after gain switching VRF24B

PB60, PB1060 Model loop gain after gain switching PG1B

PB61 to PB64, PB1061 to 
PB1064 For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

PC1, PC1001 Acceleration time constant STA

PC2, PC1002 Deceleration time constant STB

PC3, PC1003 S-pattern acceleration/deceleration time constant STC

PC4, PC1004 Torque command time constant TQC

PC5, PC1005 Internal speed command 1 SC1

PC6, PC1006 Internal speed command 2 SC2
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PC7, PC1007 Internal speed command 3 SC3

PC8, PC1008 Internal speed command 4 SC4

PC9, PC1009 Internal speed command 5 SC5

PC10, PC1010 Internal speed command 6 SC6

PC11, PC1011 Internal speed command 7 SC7

PC12, PC1012 Analog speed command maximum speed VCM

PC13, PC1013 Analog torque command maximum output TLC

PC14 to PC15, PC1014 to 
PC1015 For manufacturer setting -

PC16, PC1016 Electromagnetic brake sequence output MBR

PC17, PC1017 Zero speed ZSP

PC18, PC1018 Alarm history clear *BPS

PC19, PC1019 Encoder output pulse selection *ENRS

PC20 to PC21, PC1020 to 
PC1021 For manufacturer setting -

PC22, PC1022 Function selection C-1 *COP1

PC23, PC1023 Function selection C-2 *COP2

PC24, PC1024 Function selection C-3 *COP3

PC25, PC1025 Function selection C-4 *COP3

PC26, PC1026 Function selection C-5 *COP5

PC27, PC1027 Function selection C-6 *COP6

PC28, PC1028 For manufacturer setting -

PC29, PC1029 Function selection C-8 *COP7

PC30, PC1030 Acceleration time constant 2 STA2

PC31, PC1031 Deceleration time constant 2 STB2

PC32, PC1032 Command input pulse multiplication numerator 2 CMX2

PC33, PC1033 Command input pulse multiplication numerator 3 CMX3

PC34, PC1034 Command input pulse multiplication numerator 4 CMX4

PC35, PC1035 Internal torque limit 2 TL2

PC36, PC1036 For manufacturer setting -

PC37, PC1037 Analog speed command offset VCO

PC38, PC1038 Analog torque command offset TPO

PC39 to PC42, PC1039 to 
PC1042 For manufacturer setting -

PC43, PC1043 Error excessive alarm detection level ERZ

PC44 to PC50, PC1044 to 
PC1050 For manufacturer setting -

PC51, PC1051 Forced stop deceleration time constant RSBR

PC52 to PC53, PC1052 to 
PC1053 For manufacturer setting -

PC54, PC1054 Vertical axis freefall prevention compensation amount RSUP1

PC55 to PC59, PC1055 to 
PC1059 For manufacturer setting -

PC60, PC1060 Function selection C-D *COPD

PC61 to PC72, PC1061 to 
PC1072 For manufacturer setting -

PC73, PC1073 Error excessive warning level ERW

PC74, PC1074 For manufacturer setting -

PC75, PC1075 Following error output level FEWL

PC76, PC1076 Following error output level FEWH

PC77, PC1077 Following error output filtering time FEWF

Device name Name Symbol
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(8) I/O setting parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD48: Writing data to the RAM of a servo amplifier
• PD1001 to PD1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PC78 to PC80, PC1078 to 
PC1080 For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

PD1, PD1001 Input signal automatic on selection 1 *DIA1

PD2 to PD4, PD1002 to 
PD1004 For manufacturer setting -

PD5, PD1005 Input device selection 1L *DI1L

PD6, PD1006 Input device selection 1M *DI1M

PD7, PD1007 Input device selection 1H *DI1H

PD8, PD1008 Input device selection 2L *DI2L

PD9, PD1009 Input device selection 2M *DI2M

PD10, PD1010 Input device selection 2H *DI2H

PD11, PD1011 Input device selection 3L *DI3L

PD12, PD1012 Input device selection 3M *DI3M

PD13, PD1013 Input device selection 3H *DI3H

PD14, PD1014 Input device selection 4L *DI4L

PD15, PD1015 Input device selection 4M *DI4M

PD16, PD1016 Input device selection 4H *DI4H

PD17, PD1017 Input device selection 5L *DI5L

PD18, PD1018 Input device selection 5M *DI5M

PD19, PD1019 Input device selection 5H *DI5H

PD20 to 22, PD1020 to 
PD1022 For manufacturer setting -

PD23, PD1023 Input device selection 7L *DI7L

PD24, PD1024 Input device selection 7M *DI7M

PD25, PD1025 Input device selection 7H *DI7H

PD26, PD1026 Input device selection 8L *DI8L

PD27, PD1027 Input device selection 8M *DI8M

PD28, PD1028 Input device selection 8H *DI8H

PD29, PD1029 Output device selection 1 *DO1

PD30, PD1030 Output device selection 2 *DO2

PD31, PD1031 Output device selection 3 *DO3

PD32, PD1032 Output device selection 4 *DO4

PD33, PD1033 For manufacturer setting -

PD34, PD1034 Input filter setting *DIF

PD35, PD1035 Function selection D-1 *DOP1

PD36, PD1036 For manufacturer setting -

PD37, PD1037 Function selection D-3 *DOP3

PD38, PD1038 Function selection D-4 *DOP4

PD39, PD1039 Function selection D-5 *DOP5

PD40 to PD48, PD1040 to 
PD1048 For manufacturer setting -
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(9) Positioning control parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PT1 to PT80: Writing data to the RAM of a servo amplifier
• PT1001 to PT1080: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

Device name Name Symbol

PT1, PT1001 Command mode selection *CTY

PT2, PT1002 For manufacturer setting -

PT3, PT1003 Feeding function selection *FTY

PT4, PT1004 For manufacturer setting -

PT5, PT1005 Home position return speed ZRF

PT6, PT1006 Creep speed CRF

PT7, PT1007 Home position shift distance ZST

PT8, PT1008 For manufacturer setting -

PT9, PT1009 Moving distance after proximity dog DCT

PT10, PT1010 Stopper type home position return stopper time ZTM

PT11, PT1011 Stopper type home position return torque limit value ZTT

PT12 to PT14, PT1012 to 
PT1014 For manufacturer setting -

PT15, PT1015 Software limit + LMPL

PT16, PT1016 Software limit + LMPH

PT17, PT1017 Software limit - LMNL

PT18, PT1018 Software limit - LMNH

PT19 to 25, PT1019 to 
PT1025 For manufacturer setting -

PT26, PT1026 Function selection T-2 *TOP2

PT27 to 28, PT1027 to 
PT1028 For manufacturer setting -

PT29, PT1029 Function selection T-3 *TOP3

PT30 to PT40, PT1030 to 
PT1040 For manufacturer setting -

PT41, PT1041 Home position return inhibit selection ORP

PT42 to PT44, PT1042 to 
PT1044 For manufacturer setting -

PT45, PT1045 Home position return method HMM

PT46 to PT48, PT1046 to 
PT1048 For manufacturer setting -

PT49, PT1049 Torque slope TQS

PT50, PT1050 Profile speed command PVC

PT51, PT1051 Maximum profile speed MPVC

PT52, PT1052 Speed limit VLMT

PT53 to 56, PT1053 to 
PT1056

For manufacturer setting -

PT57, PT1057 Home position shift distance (extension parameter) ZSTH

PT58, PT1058 For manufacturer setting *ZPSH

PT59, PT1059 Travel distance after proximity dog (extension parameter) DCTH

PT60, PT1060 Function selection T-8 *TOP8

PT61, PT1061 Home position return acceleration time constant HMA

PT62, PT1062 Home position return deceleration time constant HMB

PT63, PT1063 Zero speed 2 level ZSP2L

PT64, PT1064 Zero speed 2 filter time ZSP2F
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(10)Network setting parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PN1 to PN48: Writing data to the RAM of a servo amplifier
• PN1001 to PN1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PT65, PT1065 In-position 2 output range INP2R

PT66, PT1066 In-position 2 output filter time INP2F

PT67, PT1067  Speed reached 2 output range SA2R

PT68, PT1068 Speed reached 2 output filter time SA2F

PT69 to 80, PT1069 to 
PT1080

For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

PN1, PN1001 For manufacturer setting -

PN2, PN1002 Communication error detection time CERT

PN3 to PN5, PN1003 to 
PN1005 For manufacturer setting -

PN6, PN1006 Function selection N-1 NOP1

PN7, PN1007 For manufacturer setting -

PN8, PN1008 Function selection N-2 NOP2

PN9, PN1009 For manufacturer setting -

PN10, PN1010 Ethernet communication time-out selection EIC

PN11, PN1011 IP address setting 1 *IPAD1

PN12, PN1012 IP address setting 2 *IPAD2

PN13, PN1013 IP address setting 3 *IPAD3

PN14, PN1014 IP address setting 4 *IPAD4

PN15, PN1015 Subnet mask setting 1 *SNMK1

PN16, PN1016 Subnet mask setting 2 *SNMK2

PN17, PN1017 Subnet mask setting 3 *SNMK3

PN18, PN1018 Subnet mask setting 4 *SNMK4

PN19, PN1019 Default gateway setting 1 *DGW1

PN20, PN1020 Default gateway setting 2 *DGW2

PN21, PN1021 Default gateway setting 3 *DGW3

PN22, PN1022 Default gateway setting 4 *DGW4

PN23, PN1023 KeepAlive time *KAA

PN24, PN1024 IP address filter 1 *IPAF1

PN25, PN1025 IP address filter 2 *IPAF2

PN26, PN1026 IP address filter 3 *IPAF3

PN27, PN1027 IP address filter 4 *IPAF4

PN28, PN1028 IP address filter 2 range specification *IPFR2

PN29, PN1029 IP address filter 3 range specification *IPFR3

PN30, PN1030 IP address filter 4 range specification *IPFR4

PN31, PN1031 Operation specification IP address 1 *IPOA1

PN32, PN1032 Operation specification IP address 2 *IPOA2

PN33, PN1033 Operation specification IP address 3 *IPOA3

PN34, PN1034 Operation specification IP address 4 *IPOA4

PN35, PN1035 Operation specification IP address 3 range spec. *IPOR3

PN36, PN1036 Operation specification IP address 4 range spec. *IPOR4
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(11)Status display ([MELSERVO-JE-*C])

(12)Extension setting No.2 parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PE1 to PE64: Writing data to the RAM of a servo amplifier
• PE1001 to PE1064: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

PN37 to PN48, PN1037 to 
PN1048

For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

ST0 Cumulative feedback pulses -

ST1 Servo motor speed -

ST2 Droop pulses -

ST3 Cumulative command pulses -

ST4 Command pulse frequency -

ST5 Analog speed command voltage -

ST6 Analog torque command voltage -

ST7 Regenerative load ratio -

ST8 Effective load ratio -

ST9 Peak load ratio -

ST10 Instantaneous torque -

ST11 Within one-revolution position -

ST12 ABS counter -

ST13 Load inertia moment ratio -

ST14 Bus voltage -

ST15 to ST31 For manufacturer setting -

ST32 Encoder inside temperature -

ST33 Settling time -

ST34 Oscillation detection frequency -

ST35 Number of tough drive operations -

ST36 to ST39 For manufacturer setting -

ST40 Unit power consumption -

ST41 Unit total power consumption -

ST42 Current position -

ST43 Command position -

ST44 Command remaining distance -

ST45 to ST48 For manufacturer setting -

Device name Name Symbol

PE1 to PE40, PE1001 to 
PE1040 For manufacturer setting -

PE41, PE1041 Function selection E-3 EOP3

PE42 to PE43, PE1042 to 
PE1043 For manufacturer setting -

PE44, PE1044 Lost motion compensation positive-side compensation value selection LMCP

PE45, PE1045 Lost motion compensation negative-side compensation value selection LMCN

PE46, PE1046 Lost motion filter setting LMFLT

PE47, PE1047 Torque offset TOF

PE48, PE1048 Lost motion compensation function selection *LMOP
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(13)Extension setting No.3 parameter ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• PF1 to PF48: Writing data to the RAM of a servo amplifier
• PF1001 to PF1048: Writing data to the EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.

(14)Alarm (MELSERVO-J4-*A extended) ([MELSERVO-JE-*C])

PE49, PE1049 Lost motion compensation timing LMCD

PE50, PE1050 Lost motion compensation non-sensitive band LMCT

PE51 to PE64, PE1051 to 
PE1064 For manufacturer setting -

Device name Name Symbol

Device name Name Symbol

PF1 to PF8, PF1001 to 
PF1008 For manufacturer setting -

PF9, PF1009 Function selection F-5 *FOP5

PF10 to PF14, PF1010 to 
PF1014 For manufacturer setting -

PF15, PF1015 Electronic dynamic brake operating time DBT

PF16 to PF20, PF1016 to 
PF1020

For manufacturer setting -

PF21, PF1021 Drive recorder switching time setting DRT

PF22, PF1022 For manufacturer setting -

PF23, PF1023 Vibration tough drive - Oscillation detection level OSCL1

PF24, PF1024 Vibration tough drive function selection OSCL2

PF25, PF1025 Instantaneous power failure tough drive - Detection time CVAT

PF26 to PF30, PF1026 to 
PF1030 For manufacturer setting -

PF31, PF1031 Machine diagnosis function - Friction judgment speed FRIC

PF32 to PF48, PF1032 to 
PF1048 For manufacturer setting -

Device name Name Symbol

ALM0 Current alarm number -

ALM1 Detailed data of current alarms -

ALM11 Servo status(alarm) Cumulative feedback pulses -

ALM12 Servo status(alarm) Servo motor speed -

ALM13 Servo status(alarm) Droop pulses -

ALM14 Servo status(alarm) Cumulative command pulses -

ALM15 Servo status(alarm) Command pulse frequency -

ALM16 Servo status(alarm) Analog speed command voltage -

ALM17 Servo status(alarm) Analog torque command voltage -

ALM18 Servo status(alarm) Regenerative load ratio -

ALM19 Servo status(alarm) Effective load ratio -

ALM20 Servo status(alarm) Peak load ratio -

ALM21 Servo status(alarm) Instantaneous torque -

ALM22 Servo status(alarm) Within one-revolution position -

ALM23 Servo status(alarm) ABS counter -

ALM24 Servo status(alarm) Load inertia moment ratio -

ALM25 Servo status(alarm) Bus voltage -

ALM26 to ALM42 For manufacturer setting -

ALM43 Servo status(alarm) Internal temperature of encoder -
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ALM44 Servo status(alarm) Settling time -

ALM45 Servo status(alarm) Oscillation detection frequency -

ALM46 Servo status(alarm) Number of tough drives -

ALM47 to ALM50 For manufacturer setting -

ALM51 Servo status(alarm) Unit power consumption -

ALM52 Servo status(alarm) Unit total power consumption -

ALM53 Servo status(alarm) Current position -

ALM54 Servo status(alarm) Command position -

ALM55 Servo status(alarm) Command remaining distance -

ALM56 to ALM59 For manufacturer setting -

ALM200 Alarm number from Alarm History most recent alarm -

ALM201 Alarm number from Alarm History 1st alarm in past -

ALM202 Alarm number from Alarm History 2nd alarm in past -

ALM203 Alarm number from Alarm History 3rd alarm in past -

ALM204 Alarm number from Alarm History 4th alarm in past -

ALM205 Alarm number from Alarm History 5th alarm in past -

ALM206 Alarm number from Alarm History 6th alarm in past -

ALM207 Alarm number from Alarm History 7th alarm in past -

ALM208 Alarm number from Alarm History 8th alarm in past -

ALM209 Alarm number from Alarm History 9th alarm in past -

ALM210 Alarm number from Alarm History 10th alarm in past -

ALM211 Alarm number from Alarm History 11th alarm in past -

ALM212 Alarm number from Alarm History 12th alarm in past -

ALM213 Alarm number from Alarm History 13th alarm in past -

ALM214 Alarm number from Alarm History 14th alarm in past -

ALM215 Alarm number from Alarm History 15th alarm in past -

ALM220 Alarm occurrence time in alarm history most recent alarm -

ALM221 Alarm occurrence time in alarm history 1st alarm in past -

ALM222 Alarm occurrence time in alarm history 2nd alarm in past -

ALM223 Alarm occurrence time in alarm history 3rd alarm in past -

ALM224 Alarm occurrence time in alarm history 4th alarm in past -

ALM225 Alarm occurrence time in alarm history 5th alarm in past -

ALM226 Alarm occurrence time in alarm history 6th alarm in past -

ALM227 Alarm occurrence time in alarm history 7th alarm in past -

ALM228 Alarm occurrence time in alarm history 8th alarm in past -

ALM229 Alarm occurrence time in alarm history 9th alarm in past -

ALM230 Alarm occurrence time in alarm history 10th alarm in past -

ALM231 Alarm occurrence time in alarm history 11th alarm in past -

ALM232 Alarm occurrence time in alarm history 12th alarm in past -

ALM233 Alarm occurrence time in alarm history 13th alarm in past -

ALM234 Alarm occurrence time in alarm history 14th alarm in past -

ALM235 Alarm occurrence time in alarm history 15th alarm in past -

ALM240 Detailed alarm from Alarm History most recent alarm -

ALM241 Detailed alarm from Alarm History 1st alarm in past -

ALM242 Detailed alarm from Alarm History 2nd alarm in past -

ALM243 Detailed alarm from Alarm History 3rd alarm in past -

ALM244 Detailed alarm from Alarm History 4th alarm in past -

Device name Name Symbol
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(15)Machine diagnosis data ([MELSERVO-JE-*C])

*1 While the servo amplifier is estimating the corresponding machine status in the machine diagnosis, do not write data to the 
parameters of the servo amplifier from another GOT.
Doing so may cause the servo amplifier to malfunction.

*2 When MD2 indicates that the servo amplifier does not complete the machine diagnosis (is estimating or warning of the 
machine status), do not monitor MD3 to MD6 (friction states) and MD7 to MD10 (vibration/oscillation states).
To start monitoring those devices upon the estimation completion, set [Trigger] in the applicable object settings.

(16)One-touch tuning data ([MELSERVO-JE-*C])

(17)External input signal ([MELSERVO-JE-*C])

ALM245 Detailed alarm from Alarm History 5th alarm in past -

ALM246 Detailed alarm from Alarm History 6th alarm in past -

ALM247 Detailed alarm from Alarm History 7th alarm in past -

ALM248 Detailed alarm from Alarm History 8th alarm in past -

ALM249 Detailed alarm from Alarm History 9th alarm in past -

ALM250 Detailed alarm from Alarm History 10th alarm in past -

ALM251 Detailed alarm from Alarm History 11th alarm in past -

ALM252 Detailed alarm from Alarm History 12th alarm in past -

ALM253 Detailed alarm from Alarm History 13th alarm in past -

ALM254 Detailed alarm from Alarm History 14th alarm in past -

ALM255 Detailed alarm from Alarm History 15th alarm in past -

Virtual device name Name Symbol

MD0 Machine diagnosis data parameter number -

MD1 Machine diagnosis data shift judgment (test mode) -

MD2*1 Machine diagnosis data status -

MD3*2 Machine diagnosis data coulomb friction torque in positive direction -

MD4*2 Machine diagnosis data friction torque at rated speed in positive direction -

MD5*2 Machine diagnosis data coulomb friction torque in negative direction -

MD6*2 Machine diagnosis data friction torque at rated speed in negative direction -

MD7*2 Machine diagnosis data oscillation frequency (motor is stopped) -

MD8*2 Machine diagnosis data vibration level (motor is stopped) -

MD9*2 Machine diagnosis data oscillation frequency (motor is operating) -

MD10*2 Machine diagnosis data vibration level (motor is operating) -

MD11 Machine diagnosis data, rated speed at forward or reverse rotation torque -

Device name Name Symbol

Virtual device name Name Symbol

OTS0 One-touch tuning status confirmation -

OTS1 Error code list -

OTS2 Settling time -

OTS3 Overshoot amount -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -

System informationDI1 Input device statuses -

DI2 Input device statuses -

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-JE-_C SERVO AMPLIFIER INSTRUCTION MANUAL
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(18)External output signal ([MELSERVO-JE-*C])

(19)Current position latch data ([MELSERVO-JE-*C])

(20)Value of the general-purpose register (Rx) ([MELSERVO-JE-*C])
Use an appropriate device according to the write destination of the servo amplifier.

• RR1 to RR4: Writing data to the RAM of a servo amplifier
• RR1001 to RR1004: Writing data to the EEPROM of a servo amplifier

(21)Value of the general-purpose register (Dx) ([MELSERVO-JE-*C])

(22)Life diagnosis ([MELSERVO-JE-*C])

DI4 Statuses of input devices switched on through 
communication -

System informationDI5 Statuses of input devices switched on through 
communication -

DI6 Statuses of input devices switched on through 
communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -

System informationDO1 Output device statuses -

DO2 Output device statuses -

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-JE-_C SERVO AMPLIFIER INSTRUCTION MANUAL

Virtual device name Name Symbol

LD0 Position data unit -

LD1 Current position latch data -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

Virtual device name Name Symbol

RR1, RR1001 Value of the general-purpose register (R1) -

RR2, RR1002 Value of the general-purpose register (R2) -

RR3, RR1003 Value of the general-purpose register (R3) -

RR4, RR1004 Value of the general-purpose register (R4) -

Virtual device name Name Symbol

RD1 Value of the general-purpose register (D1) -

RD2 Value of the general-purpose register (D2) -

RD3 Value of the general-purpose register (D3) -

RD4 Value of the general-purpose register (D4) -

Virtual device name Name Symbol

ALD0 Cumulative power-on time -

ALD1 Number of inrush current switching times -
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(23)Input signal for test operation (for test operation) ([MELSERVO-JE-*C])

When using the input signal for test operation (for test operation), note the following.

(24)Forced output of signal pin (for test operation) ([MELSERVO-JE-*C])

When using the forced output of signal pin (for test operation), note the following.

(25)Set data (for test operation) ([MELSERVO-JE-*C])

When using the set data (for test operation), note the following.

■8 Precautions for virtual servo amplifier devices ([MELSERVO-JE-*C])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device name Name Symbol

TMI0 Input signal for test operation 1 -

TMI1 Input signal for test operation 2 -

TMI2 Input signal for test operation 3 -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMO0 Forced output of signal pin -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol

TMD0 Writes the speed (test mode) -

TMD1 Writes the acceleration/deceleration time constant (test mode) -

TMD3 Writes the moving distance (test mode) -

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.
12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment

12 - 421



12.3.22 [MELSERVO-J5(W)-*G(-RJ), -JET-*G]

Not available to GT2105-Q.

■1 Monitoring-supported bit devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
The following table shows monitoring-supported virtual bit devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.22 ■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.22 ■7 Virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

➟■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

Specifications of word devices
➟■3 Monitoring-supported word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

➟■4 Availability of writing/reading data to/from word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

➟■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-
*G])

Specifications of virtual servo 
amplifier devices

➟■7 Virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

➟■8 Precautions for virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SP Servo amplifier request Decimal

AA(Axis designation)-SP(Device)
Notation example: AA3-SP0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

× ×

OM Operation mode selection Decimal

AA(Axis designation)-OM(Device)
Notation example: AA3-OM0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 4 to 5

× ×

TMB Instruction demand (for test 
operation) Decimal

AA(Axis designation)-TMB(Device)
Notation example: AA3-TMB1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 6

× ×

OTI One-touch tuning instruction Decimal

AA(Axis designation)-OTI(Device)
Notation example: AA3-OTI0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

× ×

GFDI Gear failure diagnosis 
instruction Decimal

AA(Axis designation)-GFDI(Device)
Notation example: AA3-GFDI0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

× ×

ECCDI Encoder communication 
circuit diagnosis instruction Decimal

AA(Axis designation)-ECCDI(Device)
Notation example: AA3-ECCDI0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

× ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
For indirect specification of an axis designation, refer to the following.

➟12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■2 Availability of writing/reading data to/from bit devices ([MELSERVO-J5(W)-*G(-RJ), -JET-
*G])

The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
The following table shows monitoring-supported virtual word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.22 ■4 Availability of writing/reading data to/from word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
For details on virtual servo amplifier devices, refer to the following.

➟12.3.22 ■7 Virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SP -/W -/- -/- -/- -/-

OM -/W -/- -/- -/- -/-

TMB -/W -/- -/- -/- -/-

OTI -/W -/- -/- -/- -/-

GFDI -/W -/- -/- -/- -/-

ECCDI -/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PA Basic setting parameter Decimal

AA(Axis designation)-PA(Device)
Notation example: AA3-PA1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

× ×

PB Gain filter parameter Decimal

AA(Axis designation)-PB(Device)
Notation example: AA3-PB1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 92, 1001 to 1092

× ×

PC Extension setting parameter Decimal

AA(Axis designation)-PC(Device)
Notation example: AA3-PC1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

× ×

PD I/O setting parameter Decimal

AA(Axis designation)-PD(Device)
Notation example: AA3-PD1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

× ×

PT Positioning control 
parameters Decimal

AA(Axis designation)-PT(Device)
Notation example: AA3-PT1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 90, 1001 to 1090

× ×
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PN Network setting parameters Decimal

AA(Axis designation)-PN(Device)
Notation example: AA3-PN1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

× ×

ST Status display Decimal

AA(Axis designation)-ST(Device)
Notation example: AA3-ST0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 48

× ×

PE Extension setting No.2 
parameter Decimal

AA(Axis designation)-PE(Device)
Notation example: AA3-PE1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 88, 1001 to 1088

× ×

PF Extension setting No.3 
parameter Decimal

AA(Axis designation)-PF(Device)
Notation example: AA3-PF1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

× ×

ALM Alarm (Current alarm) Decimal

AA(Axis designation)-ALM(Device)
Notation example: AA3-ALM0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2, 11 to 59

× ×

ALM Alarm (Alarm history) Decimal

AA(Axis designation)-ALM(Device)
Notation example: AA3-ALM200
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 200 to 215, 220 to 235, 240 

to 255, 260 to 275, 280 to 295, 300 to 315

× ×

POS Point table (position) Decimal

AA(Axis designation)-POS(Device)
Notation example: AA3-POS1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

SPD Point table (speed) Decimal

AA(Axis designation)-SPD(Device)
Notation example: AA3-SPD1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

ACT Point table (acceleration time 
constant) Decimal

AA(Axis designation)-ACT(Device)
Notation example: AA3-ACT1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

DCT Point table (deceleration time 
constant) Decimal

AA(Axis designation)-DCT(Device)
Notation example: AA3-DCT1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

DWL Point table (dwell) Decimal

AA(Axis designation)-DWL(Device)
Notation example: AA3-DWL1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

AUX Point table (auxiliary function) Decimal

AA(Axis designation)-AUX(Device)
Notation example: AA3-AUX1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

MCD Point table (M code) Decimal

AA(Axis designation)-MCD(Device)
Notation example: AA3-MCD1
• Axis designation (decimal): 1 to 3 (direct), 100 

to 115 (indirect)
• Device (decimal): 1 to 255, 1001 to 1255

× ×

MD Machine diagnosis data Decimal

AA(Axis designation)-MD(Device)
Notation example: AA3-MD0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 21

× ×

OTS One-touch tuning data Decimal

AA(Axis designation)-OTS(Device)
Notation example: AA3-OTS0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5, 3000

× ×

DI External input signal Decimal

AA(Axis designation)-DI(Device)
Notation example: AA3-DI0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 6

× ×

DO External output signal Decimal

AA(Axis designation)-DO(Device)
Notation example: AA3-DO0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 4

× ×

PO Option unit parameter Decimal

AA(Axis designation)-PO(Device)
Notation example: AA3-PO1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 2, 1001 to 1002

× ×

PS Special parameter Decimal

AA(Axis designation)-PS(Device)
Notation example: AA3-PS1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 99, 1001 to 1099

× ×

PL Linear servo motor/DD motor 
setting parameters Decimal

AA(Axis designation)-PL(Device)
Notation example: AA3-PL1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 72, 1001 to 1072

× ×

PU Multi encoder parameter Decimal

AA(Axis designation)-PU(Device)
Notation example: AA3-PU1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 44, 1001 to 1044

× ×

PVS Position extension parameter Decimal

AA(Axis designation)-PVS(Device)
Notation example: AA3-PVS1
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 1 to 32, 1001 to 1032

× ×

NPA Network basic parameter Decimal
1 to 12
2001 to 2032

× ×

GFDS Gear failure diagnosis data Decimal

AA(Axis designation)-GFDS(Device)
Notation example: AA3-GFDS0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

× ×

ECCDS Encoder communication 
circuit diagnosis data Decimal

AA(Axis designation)-ECCDS(Device)
Notation example: AA3-ECCDS0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 5

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
For indirect specification of an axis designation, refer to the following.

➟12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■4 Availability of writing/reading data to/from word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-
*G])

The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for OTS0 to OTS5.
*2 Only reading is available for DI0 to DI3.
*3 Only reading is available for NPA1, NPA8, and NPA2001 to NPA2032.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PA R/W R/W -/- -/-

PB R/W R/W -/- -/-

PC R/W R/W -/- -/-

PD R/W R/W -/- -/-

PT R/W R/W -/- -/-

PN R/W R/W -/- -/-

ST R/- R/- -/- -/-

PE R/W R/W -/- -/-

PF R/W R/W -/- -/-

ALM R/- R/- -/- -/-

POS R/W R/W -/- -/-

SPD R/W R/W -/- -/-

ACT R/W R/W -/- -/-

DCT R/W R/W -/- -/-

DWL R/W R/W -/- -/-

AUX R/W R/W -/- -/-

MCD R/W R/W -/- -/-

MD R/- R/- -/- -/-

OTS*1 R/W R/W -/- -/-

DI*2 R/- R/W -/- -/-

DO R/- R/- -/- -/-

PO R/W R/W -/- -/-

PS R/W R/W -/- -/-

PL R/W R/W -/- -/-

PU R/W R/W -/- -/-

PVS R/W R/W -/- -/-

NPA*3 R/W R/W -/- -/-

GFDS R/- R/- -/- -/-

ECCDS R/- R/- -/- -/-
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■5 Monitoring-supported double-word devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
The following table shows monitoring-supported virtual double-word devices for servo amplifiers.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.22 ■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J5(W)-*G(-RJ), -
JET-*G])

For details on virtual servo amplifier devices, refer to the following.
➟12.3.22 ■7 Virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
For indirect specification of an axis designation, refer to the following.

➟12.3.2 ■2 (2) Indirect specification of an axis number or axis designation ([MELSEC iQ-R, RnMT/NC/RT, 
CR800-D], [MELSEC iQ-R, RnMT/RT, CR800-D])

■6 Availability of writing/reading data to/from double-word devices ([MELSERVO-J5(W)-*G(-
RJ), -JET-*G])

The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

ALD Life diagnosis Decimal

AA(Axis designation)-ALD(Device)
Notation example: AA3-ALD0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1

× ×

TMI Input signal for test operation 
(for test operation) Decimal

AA(Axis designation)-TMI(Device)
Notation example: AA3-TMI0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 2

× ×

TMO Forced output of signal pin 
(for test operation) Decimal

AA(Axis designation)-TMO(Device)
Notation example: AA3-TMO0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0

× ×

TMD Set data (for test operation) Decimal

AA(Axis designation)-TMD(Device)
Notation example: AA3-TMD0
• Axis designation: 1 to 3 (direct), 100 to 115 

(indirect)
• Device (decimal): 0 to 1, 3

× ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

ALD -/- R/- -/- -/-

TMI -/- -/W -/- -/-

TMO -/- -/W -/- -/-

TMD -/- -/W -/- -/-
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■7 Virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
The following shows the correspondence between the virtual devices used in the GOT and the servo amplifier data.

Virtual device name Reference

SP ➟(1) Servo amplifier request ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

OM ➟(2) Operation mode selection ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

TMB ➟(3) Instruction demand (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

OTI ➟(4) One-touch tuning instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

GFDI ➟(5) Gear failure diagnosis instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ECCDI ➟(6) Encoder communication circuit diagnosis instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PA ➟(7) Basic setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PB ➟(8) Gain filter parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PC ➟(9) Extension setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PD ➟(10) I/O setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PT ➟(11) Positioning control parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PN ➟(12) Network setting parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ST ➟(13) Status display ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PE ➟(14) Extension setting No.2 parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PF ➟(15) Extension setting No.3 parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ALM

➟(16) Alarm ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

➟(17) Specifications of ALM260 to ALM275, ALM280 to ALM295, and ALM300 to ALM315 ([MELSERVO-J5(W)-*G(-RJ), 
-JET-*G])

POS ➟(18) Point table (position) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

SPD ➟(19) Point table (speed) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ACT ➟(20) Point table (acceleration time constant) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

DCT ➟(21) Point table (deceleration time constant) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

DWL ➟(22) Point table (dwell) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

AUX ➟(23) Point table (auxiliary function) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

MCD ➟(24) Point table (M code) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

MD ➟(25) Machine diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

OTS ➟(26) One-touch tuning data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

DI
➟(27) External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
(28) External input signal in MR-J5D□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
(29) External input signal in MR-JET-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

DO
➟(30) External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
(31) External output signal in MR-J5D□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
(32) External output signal in MR-JET-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PO ➟(33) Option unit parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PS ➟(34) Special parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PL ➟(35) Linear servo motor/DD motor setting parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PU ➟(36) Multi encoder parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

PVS ➟(37) Positioning control parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

NPA ➟(38) Network basic parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
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(1) Servo amplifier request ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the servo amplifier request, note the following.

(2) Operation mode selection ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the operation mode selection, note the following.

(3) Instruction demand (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

GFDS ➟(39) Gear failure diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ECCDS ➟(40) Encoder communication circuit diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

ALD ➟(41) Life Diagnosis ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

TMI ➟(42) Input signal for test operation (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

TMO ➟(43) Forced output of signal pin (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

TMD ➟(44) Set data (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

Virtual device name Reference

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

SP0 Status display data clear - ○ ○ ○

SP1 Current alarm clear - ○ ○ ○

SP2 Alarm history clear - ○ ○ ○

SP3 External input signal prohibited - ○ ○ ○

SP4 External output signal prohibited - ○ ○ ○

SP5 External input signal resumed - ○ ○ ○

SP6 External output signal resumed - ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

OM0 Cancel test operation mode - ○ ○ ○

OM1 JOG operation - ○ ○ ○

OM2 Positioning operation - ○ ○ ○

OM4 Output signal (DO) forced output - ○ ○ ○

OM5 Single-step feed operation - ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

TMB1 Pause - ○ ○ ○

TMB2 Test operation (positioning operation) start 
command - ○ ○ ○

TMB3 Forward rotation direction - ○ ○ ○

TMB4 Reverse rotation direction - ○ ○ ○

TMB5 Restart for remaining distance - ○ ○ ○

TMB6 Remaining distance clear - ○ ○ ○
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When using the instruction demand (for test operation), note the following.

(4) One-touch tuning instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the one-touch tuning instruction, note the following.

(5) Gear failure diagnosis instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the gear failure diagnosis instruction, note the following.

(6) Encoder communication circuit diagnosis instruction ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the encoder communication circuit diagnosis instruction, note the following.

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

OTI0 One-touch tuning start command (Basic 
mode) - ○ ○ ○

OTI1 One-touch tuning start command (High 
mode) - ○ ○ ○

OTI2 One-touch tuning start command (Low 
mode) - ○ ○ ○

OTI3 One-touch tuning stop command - ○ ○ ○

OTI4 Return to initial value - ○ ○ ○

OTI5 Return to value before adjustment - ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

GFDI0 Backlash estimation start command - ○ × ○

GFDI1 Backlash estimation stop command - ○ × ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ECCDI0 CN2 encoder communication circuit 
diagnosis start command - ○ ○ ○

ECCDI1 CN2L encoder communication circuit 
diagnosis start command - ○ ○ ○

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.
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(7) Basic setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PA1 to PA44: Writing data to the RAM of a servo amplifier
• PA1001 to PA1044: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PA1, PA1001 Operation mode **STY ○ × ○

PA2, PA1002 Regenerative option **REG ○ ○ ○

PA3, PA1003 Absolute position detection system *ABS ○ ○ ○

PA4, PA1004 Function selection A-1 *AOP1 ○ ○ ○

PA5, PA1005 For manufacturer setting - × × ×

PA6, PA1006 Electronic gear numerator *CMX ○ ○ ○

PA7, PA1007 Electronic gear denominator *CDV ○ ○ ○

PA8, PA1008 Auto tuning mode ATU ○ ○ ○

PA9, PA1009 Auto tuning response RSP ○ ○ ○

PA10, PA1010 In-position range INP ○ ○ ○

PA11, PA1011 Forward rotation torque limit TLP ○ ○ ○

PA12, PA1012 Reverse rotation torque limit TLN ○ ○ ○

PA13, PA1013 For manufacturer setting - × × ×

PA14, PA1014 Moving direction selection *POL ○ ○ ○

PA15, PA1015 Encoder output pulses *ENR ○ × ○

PA16, PA1016 Encoder output pulses 2 *ENR2 ○ × ○

PA17, PA1017 Servo motor series setting **MSR ○ × ○

PA18, PA1018 Servo motor type setting **MTY ○ × ○

PA19, PA1019 Parameter block *BLK ○ ○ ○

PA20, PA1020 Tough drive setting *TDS ○ ○ ○

PA21, PA1021 Function selection A-3 *AOP3 ○ ○ ○

PA22, PA1022 Position control structure selection **PCS ○ ○ ○

PA23, PA1023 Drive recorder arbitrary alarm trigger setting DRAT ○ ○ ○

PA24, PA1024 Function selection A-4 AOP4 ○ ○ ○

PA25, PA1025 One-touch tuning - Overshoot permissible 
level OTHOV ○ ○ ○

PA26, PA1026 Function selection A-5 *AOP5 ○ ○ ○

PA27, PA1027 For manufacturer setting - × × ×

PA28, PA1028 Function selection A-6 **AOP6 ○ ○ ○

PA29 to PA33, 
PA1029 to PA1033 For manufacturer setting - × × ×

PA34, PA1034 Quick tuning permissible travel distance QDIS ○ ○ ○

PA35 to PA44, 
PA1035 to PA1044 For manufacturer setting - × × ×
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(8) Gain filter parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PB1 to PB92: Writing data to the RAM of a servo amplifier
• PB1001 to PB1092: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PB1, PB1001 Adaptive tuning mode (Adaptive filter II) FILT ○ ○ ○

PB2, PB1002 Vib. supp. ctrl tuning mode (Adv. vib. supp. 
ctrl II) VRFT ○ ○ ○

PB3, PB1003 Torque feedback loop gain TFBGN × × ○

PB4, PB1004 Feed forward gain FFC ○ ○ ○

PB5, PB1005 For manufacturer setting - × × ×

PB6, PB1006 Load inertia moment ratio/Load mass ratio GD2 ○ ○ ○

PB7, PB1007 Model control gain PG1 ○ ○ ○

PB8, PB1008 Position control gain PG2 ○ ○ ○

PB9, PB1009 Speed control gain VG2 ○ ○ ○

PB10, PB1010 Speed integral compensation VIC ○ ○ ○

PB11, PB1011 Speed differential compensation VDC ○ ○ ○

PB12, PB1012 Overshoot amount compensation OVA ○ ○ ○

PB13, PB1013 Machine resonance suppression filter 1 NH1 ○ ○ ○

PB14, PB1014 Notch shape selection 1 NHQ1 ○ ○ ○

PB15, PB1015 Machine resonance suppression filter 2 NH2 ○ ○ ○

PB16, PB1016 Notch shape selection 2 NHQ2 ○ ○ ○

PB17, PB1017 Shaft resonance suppression filter NHF ○ ○ ○

PB18, PB1018 Low-pass filter setting LPF ○ ○ ○

PB19, PB1019 Vibration suppression control 1 - Vibration 
frequency VRF11 ○ ○ ○

PB20, PB1020 Vibration suppression control 1 - Resonance 
frequency VRF12 ○ ○ ○

PB21, PB1021 Vibration suppression control 1 - Vibration 
frequency damping VRF13 ○ ○ ○

PB22, PB1022 Vibration suppression control 1 - Resonance 
frequency damping VRF14 ○ ○ ○

PB23, PB1023 Low-pass filter setting VFBF ○ ○ ○

PB24, PB1024 Slight vibration suppression control *MVS ○ ○ ○

PB25, PB1025 Function selection B-1 *BOP1 ○ ○ ○

PB26, PB1026 Gain switching function *CDP ○ ○ ○

PB27, PB1027 Gain switching condition CDL ○ ○ ○

PB28, PB1028 Gain switching time constant CDT ○ ○ ○

PB29, PB1029 Gain changing - Load in. mom. rat./Load 
mass rat. GD2B ○ ○ ○

PB30, PB1030 Position loop gain after gain switching PG2B ○ ○ ○

PB31, PB1031 Speed loop gain after gain switching VG2B ○ ○ ○

PB32, PB1032 Speed integral compensation after gain 
switching VICB ○ ○ ○

PB33, PB1033 Vibration suppression control 1 - Vibration 
frequency after gain switching VRF11B ○ ○ ○

PB34, PB1034 Vibration suppression control 1 - Resonance 
frequency after gain switching VRF12B ○ ○ ○
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PB35, PB1035 Vibration suppression control 1 - Vibration 
frequency damping after gain switching VRF13B ○ ○ ○

PB36, PB1036 Vibration suppression control 1 - Resonance 
frequency damping after gain switching VRF14B ○ ○ ○

PB37 to PB44, 
PB1037 to PB1044 For manufacturer setting - × × ×

PB45, PB1045 Command notch filter CNHF ○ ○ ○

PB46, PB1046 Machine resonance suppression filter 3 NH3 ○ ○ ○

PB47, PB1047 Notch shape selection 3 NHQ3 ○ ○ ○

PB48, PB1048 Machine resonance suppression filter 4 NH4 ○ ○ ○

PB49, PB1049 Notch shape selection 4 NHQ4 ○ ○ ○

PB50, PB1050 Machine resonance suppression filter 5 NH5 ○ ○ ○

PB51, PB1051 Notch shape selection 5 NHQ5 ○ ○ ○

PB52, PB1052 Vibration suppression control 2 - Vibration 
frequency VRF21 ○ ○ ○

PB53, PB1053 Vibration suppression control 2 - Resonance 
frequency VRF22 ○ ○ ○

PB54, PB1054 Vibration suppression control 2 - Vibration 
frequency damping VRF23 ○ ○ ○

PB55, PB1055 Vibration suppression control 2 - Resonance 
frequency damping VRF24 ○ ○ ○

PB56, PB1056 Vibration suppression control 2 - Vibration 
frequency after gain switching VRF21B ○ ○ ○

PB57, PB1057 Vibration suppression control 2 - Resonance 
frequency after gain switching VRF22B ○ ○ ○

PB58, PB1058 Vibration suppression control 2 - Vibration 
frequency damping after gain switching VRF23B ○ ○ ○

PB59, PB1059 Vibration suppression control 2 - Resonance 
frequency damping after gain switching VRF24B ○ ○ ○

PB60, PB1060 Model loop gain after gain switching PG1B ○ ○ ○

PB61 to PB64, 
PB1061 to PB1064 For manufacturer setting - × × ×

PB65, PB1065 Gain changing 2 condition CDL2 ○ ○ ○

PB66, PB1066 Gain changing 2 time constant CDT2 ○ ○ ○

PB67, PB1067 Gain changing 2 - Load in. mom. rat./Load 
mass rat. GD2C ○ ○ ○

PB68, PB1068 Gain changing 2 position loop gain PG2C ○ ○ ○

PB69, PB1069 Gain changing 2 speed loop gain VG2C ○ ○ ○

PB70, PB1070 Gain changing 2 speed integral 
compensation VICC ○ ○ ○

PB71, PB1071 Vib. supp. ctrl. 1 - Vib. frq. after gain 
changing 2 VRF11C ○ ○ ○

PB72, PB1072 Vib. supp. ctrl. 1 - Res. frq. after gain 
changing 2 VRF12C ○ ○ ○

PB73, PB1073 Vib. supp. ctrl. 1 - Vib. frq. damping aft. gain 
chng2 VRF13C ○ ○ ○

PB74, PB1074 Vib. supp. ctrl. 1 - Res. frq. damping aft. gain 
chng2 VRF14C ○ ○ ○

PB75, PB1075 Vib. supp. ctrl. 2 - Vib. frq. after gain 
changing 2 VRF21C ○ ○ ○

PB76, PB1076 Vib. supp. ctrl. 2 - Res. frq. after gain 
changing 2 VRF22C ○ ○ ○

PB77, PB1077 Vib. supp. ctrl. 2 - Vib. frq. damping aft. gain 
chng2 VRF23C ○ ○ ○

PB78, PB1078 Vib. supp. ctrl. 2 - Res. frq. damping aft. gain 
chng2 VRF24C ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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(9) Extension setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PC1 to PC90: Writing data to the RAM of a servo amplifier
• PC1001 to PC1090: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PB79, PB1079 Gain changing 2 model loop gain PG1C ○ ○ ○

PB80, PB1080 For manufacturer setting - × × ×

PB81, PB1081 Command filter *CFIL ○ ○ ○

PB82, PB1082 Position command smoothing filter time 
constant PFT ○ ○ ○

PB83 to PB92, 
PB1083 to PB1092 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PC1, PC1001 Error excessive alarm level ERZ ○ ○ ○

PC2, PC1002 Electromagnetic brake sequence output MBR ○ ○ ○

PC3, PC1003 Encoder output pulse selection *ENRS ○ × ○

PC4, PC1004 Function selection C-1 **COP1 ○ ○ ○

PC5, PC1005 Function selection C-2 **COP2 ○ ○ ○

PC6, PC1006 Function selection C-3 *COP3 ○ ○ ○

PC7, PC1007 Zero speed ZSP ○ ○ ○

PC8, PC1008 Overspeed alarm detection level OSL ○ ○ ○

PC9, PC1009 Analog monitor 1 output MOD1 ○ × ○

PC10, PC1010 Analog monitor 2 output MOD2 ○ × ○

PC11, PC1011 Analog monitor 1 offset MO1 ○ × ○

PC12, PC1012 Analog monitor 2 offset MO2 ○ × ○

PC13 to PC15, 
PC1013 to PC1015 For manufacturer setting - × × ×

PC16, PC1016 Function selection C-3A *COP3A ○ × ○

PC17, PC1017 Function selection C-4 **COP4 ○ × ○

PC18, PC1018 For manufacturer setting - × × ×

PC19, PC1019 Function selection C-6 *COP6 ○ ○ ○

PC20, PC1020 Function selection C-7 *COP7 ○ ○ ○

PC21, PC1021 Alarm history clear *BPS ○ ○ ○

PC22 and PC23, 
PC1022 and 
PC1023

For manufacturer setting - × × ×

PC24, PC1024 Forced stop deceleration time constant RSBR ○ ○ ○

PC25, PC1025 For manufacturer setting - × × ×

PC26, PC1026 Function selection C-8 **COP8 ○ × ○

PC27, PC1027 Function selection C-9 **COP9 ○ ○ ○

PC28, PC1028 For manufacturer setting - × × ×

PC29, PC1029 Function selection C-B *COPB ○ ○ ○

PC30, PC1030 For manufacturer setting - × × ×

PC31, PC1031 Vertical ax.freefall prevention compensation 
amount RSUP1 ○ ○ ○

PC32 to PC37, 
PC1032 to PC1037 For manufacturer setting - × × ×

PC38, PC1038 Error excessive warning level ERW ○ ○ ○
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(10)I/O setting parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PD1 to PD72: Writing data to the RAM of a servo amplifier
• PD1001 to PD1072: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PC39 to PC40, 
PC1039 to PC1040 For manufacturer setting - × × ×

PC41, PC1041 Function selection C-J *COPJ × × ○

PC42 to PC45, 
PC1042 to PC1045 For manufacturer setting - × × ×

PC46, PC1046 Drive unit function selection 2 *DUOP2 × × ○

PC47 to PC64, 
PC1047 to PC1064 For manufacturer setting - × × ×

PC65, PC1065 Zero speed 2 level ZSP2L ○ × ○

PC66, PC1066 Zero speed 2 filter time ZSP2F ○ × ○

PC67, PC1067 Following error output level FEW ○ ○ ○

PC68, PC1068 For manufacturer setting - × × ×

PC69, PC1069 Following error output filter time FEWF ○ ○ ○

PC70, PC1070 In-position 2 output range INP2R ○ × ○

PC71, PC1071 In-position 2 output filter time INP2F ○ × ○

PC72, PC1072 Speed reached 2 output range SA2R ○ × ○

PC73, PC1073 Speed reached 2 output filter time SA2F ○ × ○

PC74 to PC75, 
PC1074 to PC1075 For manufacturer setting - × × ×

PC76, PC1076 Function selection C-E *COPE ○ ○ ○

PC77, PC1077 For manufacturer setting - × × ×

PC78, PC1078 Function selection C-F *COPF ○ ○ ○

PC79, PC1079 Function selection C-G *COPG ○ ○ ○

PC80, PC1080 For manufacturer setting - × × ×

PC81, PC1081 Function selection C-H **COPH ○ × ×

PC82 to PC90, 
PC1082 to PC1090 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PD1, PD1001 Input signal automatic on selection 1 *DIA1 ○ ○ ○

PD2, PD1002 For manufacturer setting - × × ×

PD3, PD1003 Input device selection 1 *DI1 ○ ○ ○

PD4, PD1004 Input device selection 2 *DI2 ○ ○ ○

PD5, PD1005 Input device selection 3 *DI3 ○ ○ ○

PD6, PD1006 For manufacturer setting - × × ×

PD7, PD1007 Output device selection 1 *DO1 ○ ○ ○

PD8, PD1008 Output device selection 2 *DO2 ○ ○ ○

PD9, PD1009 Output device selection 3 *DO3 ○ ○ ○

PD10, PD1010 For manufacturer setting - × × ×

PD11, PD1011 Input filter setting *DIF ○ ○ ○

PD12, PD1012 Function selection D-1 *DOP1 ○ ○ ○

PD13, PD1013 Function selection D-2 *DOP2 ○ ○ ○

PD14, PD1014 Function selection D-3 *DOP3 ○ ○ ○
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(11)Positioning control parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PT1 to PT90: Writing data to the RAM of a servo amplifier
• PT1001 to PT1090: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PD15 to PD37, 
PD1015 to PD1037 For manufacturer setting - × × ×

PD38, PD1038 Input device selection 4 *DI4 ○ × ○

PD39, PD1039 Input device selection 5 *DI5 ○ × ○

PD40, PD1040 For manufacturer setting - × × ×

PD41, PD1041 Function selection D-4 *DOP4 ○ ○ ○

PD42 to PD50, 
PD1042 to PD1050 For manufacturer setting - × × ×

PD51, PD1051 Input device selection 3-2 *DI3W2 ○ × ○

PD52 to PD59, 
PD1052 to PD1059 For manufacturer setting - × × ×

PD60, PD1060 DI pin polarity selection *DIP ○ ○ ○

PD61 to PD72, 
PD1061 to PD1072 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PT1, PT1001 Command mode selection **CTY ○ ○ ○

PT2, PT1002 Function selection T-1 *TOP1 ○ × ○

PT3 to PT4, PT1003 
to PT1004 For manufacturer setting - × × ×

PT5, PT1005 Home position return speed ZRF ○ ○ ○

PT6, PT1006 Creep speed CRF ○ ○ ○

PT7, PT1007 Home position shift distance ZST ○ ○ ○

PT8, PT1008 Home position return position data ZPS ○ ○ ○

PT9, PT1009 Moving distance after proximity dog DCT ○ ○ ○

PT10, PT1010 Stopper type home position return stopper 
time ZTM ○ ○ ○

PT11, PT1011 Stopper type home position return torque 
limit value ZTT ○ ○ ○

PT12, PT1012 Rough match output range CRP ○ × ○

PT13 to PT14, 
PT1013 to PT1014 For manufacturer setting - × × ×

PT15, PT1015 Software position limit+ LMP ○ ○ ○

PT16, PT1016 For manufacturer setting - × × ×

PT17, PT1017 Software position limit- LMN ○ ○ ○

PT18, PT1018 For manufacturer setting - × × ×

PT19, PT1019 Position range output 1 address+ *LPP1 ○ × ○

PT20, PT1020 For manufacturer setting - × × ×

PT21, PT1021 Position range output 1 address- *LNP1 ○ × ○

PT22 to PT28, 
PT1022 to PT1028 For manufacturer setting - × × ×

PT29, PT1029 Function selection T-3 *TOP3 ○ ○ ○

PT30 to PT33, 
PT1030 to PT1033 For manufacturer setting - × × ×

PT34, PT1034 Positioning operation data default **PDEF × × ○
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(12)Network setting parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PN1 to PN32: Writing data to the RAM of a servo amplifier
• PN1001 to PN1032: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

PT35 to PT37, 
PT1035 to PT1037 For manufacturer setting - × × ×

PT38, PT1038 Function selection T-7 **TOP7 × × ○

PT39 to PT40, 
PT1039 to PT1040 For manufacturer setting - × × ×

PT41, PT1041 Function selection T-8 TOP8 ○ ○ ○

PT42 to PT44, 
PT1042 to PT1044 For manufacturer setting - × × ×

PT45, PT1045 Home position return method HMM ○ ○ ○

PT46 to PT48, 
PT1046 to PT1048 For manufacturer setting - × × ×

PT49, PT1049 Acceleration time constant STA ○ × ○

PT50, PT1050 Deceleration time constant STB ○ × ○

PT51, PT1051 S-pattern acceleration/deceleration time 
constant STC ○ × ○

PT52, PT1052 For manufacturer setting - × × ×

PT53, PT1053 Torque slope TQS ○ × ○

PT54, PT1054 For manufacturer setting - × × ×

PT55, PT1055 Function selection T-10 *TOP10 ○ ○ ○

PT56, PT1056 Home position return acceleration time 
constant HMA ○ ○ ○

PT57, PT1057 Home position return deceleration time 
constant HMB ○ ○ ○

PT58 to PT64, 
PT1058 to PT1064 For manufacturer setting - × × ×

PT65, PT1065 Profile speed command PVC ○ × ○

PT66, PT1066 Maximum profile speed MPVC ○ × ○

PT67, PT1067 Speed limit VLMT ○ ○ ○

PT68, PT1068 Function selection T-11 TOP11 ○ ○ ○

PT69 to PT90, 
PT1069 to PT1090 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PN1, PN1001 For manufacturer setting - × × ×

PN2, PN1002 Communication error detection time CERT ○ ○ ○

PN3 to PN4, 
PN1003 to PN1004 For manufacturer setting - × × ×

PN5, PN1005 Communication error detection frequency 
setting CERI ○ ○ ○

PN6 to PN12, 
PN1006 to PN1012 For manufacturer setting - × × ×

PN13, PN1013 Network protocol setup **NPS × × ○

PN14 to PN19, 
PN1014 to PN1019 For manufacturer setting - × × ×

PN20, PN1020 Automatic parameter backup update interval **PABI ○ ○ ○

PN21, PN1021 For manufacturer setting - × × ×
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(13)Status display ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

PN22 , PN1022 Function selection N-5 **NOP5 × × ○

PN23 to PN32, 
PN1023 to PN1032 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ST0 Cumulative feedback pulses - ○ ○ ○

ST1 Servo motor speed - ○ ○ ○

ST2 Droop pulses - ○ ○ ○

ST3 Cumulative command pulses - ○ ○ ○

ST4 Command pulse frequency - ○ ○ ○

ST5 to ST6 For manufacturer setting - × × ×

ST7 Regenerative load ratio - ○ ○ ○

ST8 Effective load ratio - ○ ○ ○

ST9 Peak load ratio - ○ ○ ○

ST10 Torque/Instantaneous torque - ○ ○ ○

ST11 Within one-revolution position - ○ ○ ○

ST12 ABS counter - ○ ○ ○

ST13 Load inertia moment ratio - ○ ○ ○

ST14 Bus voltage - ○ ○ ○

ST15 Load-side cumulative feedback pulses - ○ × ○

ST16 Load side encoder droop pulses - ○ × ○

ST17 Load-side encoder information 1 - ○ × ○

ST18 Load-side encoder information 2 - ○ × ○

ST19 to ST21 For manufacturer setting - × × ×

ST22 Temperature of servo motor thermistor - ○ ○ ○

ST23 Cumulative feedback pulses (Motor unit) - ○ ○ ○

ST24 Electrical angle - ○ × ○

ST25 to ST29 For manufacturer setting - × × ×

ST30 Motor/load side position difference - ○ × ○

ST31 Motor/load side speed difference - ○ × ○

ST32 Encoder inside temperature - ○ ○ ○

ST33 Settling time - ○ ○ ○

ST34 Oscillation detection frequency - ○ ○ ○

ST35 Number of tough drive operations - ○ ○ ○

ST36 to ST39 For manufacturer setting - × × ×

ST40 Unit power consumption - ○ ○ ○

ST41 Unit total power consumption - ○ ○ ○

ST42 to ST48 For manufacturer setting - × × ×
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(14)Extension setting No.2 parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PE1 to PE88: Writing data to the RAM of a servo amplifier
• PE1001 to PE1088: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

(15)Extension setting No.3 parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PF1 to PF99: Writing data to the RAM of a servo amplifier
• PF1001 to PF1099: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PE1, PE1001 Fully closed loop function selection 1 **FCT1 ○ × ○

PE2, PE1002 For manufacturer setting - × × ×

PE3, PE1003 Fully closed loop function selection 2 *FCT2 ○ × ○

PE4, PE1004 Fully closed loop ctrl. - F/B pls. elec. gear 1 
nmrtr. **FBN ○ × ○

PE5, PE1005 Fully closed loop ctrl. - F/B pls. elec. gear 1 
dnmntr. **FBD ○ × ○

PE6, PE1006 Fully closed loop ctrl. - Spd. dev. err. 
detection level BC1 ○ × ○

PE7, PE1007 Fully closed loop ctrl. - Pos. dev. err. 
detection level BC2 ○ × ○

PE8, PE1008 Fully closed dual feedback filter DUF ○ × ○

PE9, PE1009 For manufacturer setting - × × ×

PE10, PE1010 Fully closed loop function selection 3 FCT3 ○ × ○

PE11 to PE40, 
PE1011 to PE1040 For manufacturer setting - × × ×

PE41, PE1041 Function selection E-3 EOP3 ○ ○ ○

PE42 to PE43, 
PE1042 to PE1043 For manufacturer setting - × × ×

PE44, PE1044 Lost motion compensation positive-side 
compensation value selection LMCP ○ ○ ○

PE45, PE1045 Lost motion compensation negative-side 
compensation value selection LMCN ○ ○ ○

PE46, PE1046 Lost motion filter setting LMFLT ○ ○ ○

PE47, PE1047 Unbalanced torque offset TOF ○ ○ ○

PE48, PE1048 Lost motion compensation function selection *LMOP ○ ○ ○

PE49, PE1049 Lost motion compensation timing LMCD ○ ○ ○

PE50, PE1050 Lost motion compensation non-sensitive 
band LMCT ○ ○ ○

PE51, PE1051 Load-side encoder resolution setting **EDV2 × × ○

PE52, PE1052 For manufacturer setting - × × ×

PE53, PE1053 Maximum torque limit 1 TLMX1 ○ ○ ○

PE54 to PE88, 
PE1054 to PE1088 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PF1, PF1001 For manufacturer setting - × × ×
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PF2, PF1002 Function selection F-2 *FOP2 ○ ○ ○

PF3 to PF5, PF1003 
to PF1005 For manufacturer setting - × × ×

PF6, PF1006 Function selection F-5 *FOP5 ○ ○ ○

PF7 to PF11, 
PF1007 to PF1011 For manufacturer setting - × × ×

PF12, PF1012 Electronic dynamic brake operating time DBT ○ ○ ○

PF13 to PF17, 
PF1013 to PF1017 For manufacturer setting - × × ×

PF18, PF1018 STO diagnostic error detection time **STOD ○ × ○

PF19, PF1019 Friction failure prediction compen. coefficient 
1 TSL ○ × ○

PF20, PF1020 Friction failure prediction compen. coefficient 
2 TIC ○ × ○

PF21, PF1021 Drive recorder switching time setting DRT ○ ○ ○

PF22, PF1022 For manufacturer setting - × × ×

PF23, PF1023 Vibration tough drive - Oscillation detection 
level OSCL1 ○ ○ ○

PF24, PF1024 Function selection F-9 *FOP9 ○ ○ ○

PF25, PF1025

SEMI-F47 Inst pwr.fail.det.t. (Inst 
pwr.fail.tuf.drv.) CVAT ○ × ○

Instantaneous power failure tough drive - 
Detection time CVAT × ○ ×

PF26 to PF28, 
PF1026 to PF1028 For manufacturer setting - × × ×

PF29, PF1029 Function selection F-10 *FOP10 × × ○

PF30, PF1030 For manufacturer setting - × × ×

PF31, PF1031 Machine diagnosis function - Friction 
judgment speed FRIC ○ ○ ○

PF32, PF1032 Oscillation detection alarm time *VIBT ○ ○ ○

PF33, PF1033 For manufacturer setting - × × ×

PF34, PF1034 Machine diagnosis function selection *MFP ○ ○ ○

PF35 to PF39, 
PF1035 to PF1039 For manufacturer setting - × × ×

PF40, PF1040 Machine failure prediction parameter MFPP ○ × ○

PF41, PF1041 Failure prediction - Servo motor total move 
distance FPMT ○ × ○

PF42, PF1042 Friction failure prediction average 
characteristic PAV ○ × ○

PF43, PF1043 Friction failure prediction standard deviation PSD ○ × ○

PF44, PF1044 For manufacturer setting - × × ×

PF45, PF1045 Vibration failure prediction average 
characteristic VAV ○ × ○

PF46, PF1046 Vibration failure prediction standard 
deviation VSC ○ × ○

PF47, PF1047 Servo motor total move distance offset TMO ○ × ○

PF48 to PF65, 
PF1048 to PF1065 For manufacturer setting - × × ×

PF66, PF1066 Gear ratio setting for backlash estimation BLG ○ × ○

PF67, PF1067 Backlash nominal value BLN ○ × ○

PF68, PF1068 Backlash threshold magnification BLTT ○ × ○

PF69, PF1069 Static friction failure prediction avg. 
characteristic SPAV2 ○ × ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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(16)Alarm ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

PF70, PF1070 Static friction failure prediction standard 
deviation SPSD2 ○ × ○

PF71, PF1071 Belt failure prediction function selection BFP ○ × ○

PF72, PF1072 Belt tension at installation SBT ○ × ○

PF73, PF1073 Belt tension at extension ABT ○ × ○

PF74, PF1074 Static friction at installation SSF ○ × ○

PF75, PF1075 Static friction at extension ASF ○ × ○

PF76, PF1076 Belt tension error threshold BTS ○ × ○

PF77 to PF79, 
PF1077 to PF1079 For manufacturer setting - × × ×

PF80, PF1080 Drive recorder Operation condition selection DRMC ○ ○ ○

PF81, PF1081 Drive recorder Sampling operation selection DRMS ○ ○ ○

PF82, PF1082 Drive recorder Trigger operation selection DRTM ○ ○ ○

PF83, PF1083 Drive recorder Trigger operation axis 
common sel. **DRTAX ○ × ○

PF84, PF1084 Drive recorder Trigger channel selection DRTC ○ ○ ○

PF85, PF1085 Drive recorder Trigger level setting 1 DRTL1 ○ ○ ○

PF86, PF1086 Drive recorder Trigger level setting 2 DRTL2 ○ ○ ○

PF87, PF1087 Drive recorder Analog channel setting 1 DRAC1 ○ ○ ○

PF88, PF1088 Drive recorder Analog channel setting 2 DRAC2 ○ ○ ○

PF89, PF1089 Drive recorder Analog channel setting 3 DRAC3 ○ ○ ○

PF90, PF1090 Drive recorder Analog channel setting 4 DRAC4 ○ ○ ○

PF91, PF1091 Drive recorder Digital channel setting 1 DRDC1 ○ ○ ○

PF92, PF1092 Drive recorder Digital channel setting 2 DRDC2 ○ ○ ○

PF93, PF1093 Drive recorder Digital channel setting 3 DRDC3 ○ ○ ○

PF94, PF1094 Drive recorder Digital channel setting 4 DRDC4 ○ ○ ○

PF95, PF1095 Drive recorder History clear **DRCLR ○ ○ ○

PF96 to PF99, 
PF1096 to PF1099 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ALM0 Current alarm number - ○ ○ ○

ALM1 Detailed data of current alarms - ○ ○ ○

ALM2*1 Currently occurring alarm number and detail 
number - ○ ○ ○

ALM11 Servo status(alarm) Cumulative feedback 
pulses - ○ ○ ○

ALM12 Servo status(alarm) Servo motor speed - ○ ○ ○

ALM13 Servo status(alarm) Droop pulses - ○ ○ ○

ALM14 Servo status(alarm) Cumulative command 
pulses - ○ ○ ○

ALM15 Servo status(alarm) Command pulse 
frequency - ○ ○ ○

ALM16 to ALM17 For manufacturer setting - × × ×

ALM18 Servo status(alarm) Regenerative load ratio - ○ ○ ○

ALM19 Servo status(alarm) Effective load ratio - ○ ○ ○

ALM20 Servo status(alarm) Peak load ratio - ○ ○ ○

ALM21 Servo status(alarm) Torque/Instantaneous 
torque - ○ ○ ○
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ALM22 Servo status(alarm) Within one-revolution 
position - ○ ○ ○

ALM23 Servo status(alarm) ABS counter - ○ ○ ○

ALM24 Servo status(alarm) Load inertia moment 
ratio - ○ ○ ○

ALM25 Servo status(alarm) Bus voltage - ○ ○ ○

ALM26 Servo status(alarm) Load-side cumulative 
feedback pulses - ○ × ○

ALM27 Servo status(alarm) Load side encoder 
droop pulses - ○ × ○

ALM28 Servo status(alarm) Load-side encoder 
information 1 - ○ × ○

ALM29 Servo status(alarm) Load-side encoder 
information 2 - ○ × ○

ALM30 to ALM32 For manufacturer setting - × × ×

ALM33 Servo status(alarm) Temperature of servo 
motor thermistor - ○ ○ ○

ALM34 Servo status(alarm) Cumulative feedback 
pulses (Motor unit) - ○ ○ ○

ALM35 Servo status(alarm) Electrical angle - ○ × ○

ALM36 to ALM40 For manufacturer setting - × × ×

ALM41 Servo status(alarm) Motor/load side position 
difference - ○ × ○

ALM42 Servo status(alarm) Motor/load side speed 
difference - ○ × ○

ALM43 Servo status(alarm) Encoder inside 
temperature - ○ ○ ○

ALM44 Servo status(alarm) Settling time - ○ ○ ○

ALM45 Servo status(alarm) Oscillation detection 
frequency - ○ ○ ○

ALM46 Servo status(alarm) Number of tough drive 
operations - ○ ○ ○

ALM47 to ALM50 For manufacturer setting - × × ×

ALM51 Servo status(alarm) Unit power consumption - ○ ○ ○

ALM52 Servo status(alarm) Unit power consumption - ○ ○ ○

ALM53 to ALM59 For manufacturer setting - × × ×

ALM200 Alarm number in alarm history: most recent 
alarm - ○ ○ ○

ALM201 Alarm number in alarm history: 1st alarm in 
past - ○ ○ ○

ALM202 Alarm number in alarm history: 2nd alarm in 
past - ○ ○ ○

ALM203 Alarm number in alarm history: 3rd alarm in 
past - ○ ○ ○

ALM204 Alarm number in alarm history: 4th alarm in 
past - ○ ○ ○

ALM205 Alarm number in alarm history: 5th alarm in 
past - ○ ○ ○

ALM206 Alarm number in alarm history: 6th alarm in 
past - ○ ○ ○

ALM207 Alarm number in alarm history: 7th alarm in 
past - ○ ○ ○

ALM208 Alarm number in alarm history: 8th alarm in 
past - ○ ○ ○

ALM209 Alarm number in alarm history: 9th alarm in 
past - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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ALM210 Alarm number in alarm history: 10th alarm in 
past - ○ ○ ○

ALM211 Alarm number in alarm history: 11th alarm in 
past - ○ ○ ○

ALM212 Alarm number in alarm history: 12th alarm in 
past - ○ ○ ○

ALM213 Alarm number in alarm history: 13th alarm in 
past - ○ ○ ○

ALM214 Alarm number in alarm history: 14th alarm in 
past - ○ ○ ○

ALM215 Alarm number in alarm history: 15th alarm in 
past - ○ ○ ○

ALM220 Alarm occurrence time (cumulative power-
on time) in alarm history: most recent alarm - ○ ○ ○

ALM221 Alarm occurrence time (cumulative power-
on time) in alarm history: 1st alarm in past - ○ ○ ○

ALM222 Alarm occurrence time (cumulative power-
on time) in alarm history: 2nd alarm in past - ○ ○ ○

ALM223 Alarm occurrence time (cumulative power-
on time) in alarm history: 3rd alarm in past - ○ ○ ○

ALM224 Alarm occurrence time (cumulative power-
on time) in alarm history: 4th alarm in past - ○ ○ ○

ALM225 Alarm occurrence time (cumulative power-
on time) in alarm history: 5th alarm in past - ○ ○ ○

ALM226 Alarm occurrence time (cumulative power-
on time) in alarm history: 6th alarm in past - ○ ○ ○

ALM227 Alarm occurrence time (cumulative power-
on time) in alarm history: 7th alarm in past - ○ ○ ○

ALM228 Alarm occurrence time (cumulative power-
on time) in alarm history: 8th alarm in past - ○ ○ ○

ALM229 Alarm occurrence time (cumulative power-
on time) in alarm history: 9th alarm in past - ○ ○ ○

ALM230 Alarm occurrence time (cumulative power-
on time) in alarm history: 10th alarm in past - ○ ○ ○

ALM231 Alarm occurrence time (cumulative power-
on time) in alarm history: 11th alarm in past - ○ ○ ○

ALM232 Alarm occurrence time (cumulative power-
on time) in alarm history: 12th alarm in past - ○ ○ ○

ALM233 Alarm occurrence time (cumulative power-
on time) in alarm history: 13th alarm in past - ○ ○ ○

ALM234 Alarm occurrence time (cumulative power-
on time) in alarm history: 14th alarm in past - ○ ○ ○

ALM235 Alarm occurrence time (cumulative power-
on time) in alarm history: 15th alarm in past - ○ ○ ○

ALM240 Alarm detail number in alarm history: most 
recent alarm - ○ ○ ○

ALM241 Alarm detail number in alarm history: 1st 
alarm in past - ○ ○ ○

ALM242 Alarm detail number in alarm history: 2nd 
alarm in past - ○ ○ ○

ALM243 Alarm detail number in alarm history: 3rd 
alarm in past - ○ ○ ○

ALM244 Alarm detail number in alarm history: 4th 
alarm in past - ○ ○ ○

ALM245 Alarm detail number in alarm history: 5th 
alarm in past - ○ ○ ○

ALM246 Alarm detail number in alarm history: 6th 
alarm in past - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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ALM247 Alarm detail number in alarm history: 7th 
alarm in past - ○ ○ ○

ALM248 Alarm detail number in alarm history: 8th 
alarm in past - ○ ○ ○

ALM249 Alarm detail number in alarm history: 9th 
alarm in past - ○ ○ ○

ALM250 Alarm detail number in alarm history: 10th 
alarm in past - ○ ○ ○

ALM251 Alarm detail number in alarm history: 11th 
alarm in past - ○ ○ ○

ALM252 Alarm detail number in alarm history: 12th 
alarm in past - ○ ○ ○

ALM253 Alarm detail number in alarm history: 13th 
alarm in past - ○ ○ ○

ALM254 Alarm detail number in alarm history: 14th 
alarm in past - ○ ○ ○

ALM255 Alarm detail number in alarm history: 15th 
alarm in past - ○ ○ ○

ALM260 Alarm occurrence time (year, month) in 
alarm history: most recent alarm - ○ ○ ○

ALM261 Alarm occurrence time (year, month) in 
alarm history: 1st alarm in past - ○ ○ ○

ALM262 Alarm occurrence time (year, month) in 
alarm history: 2nd alarm in past - ○ ○ ○

ALM263 Alarm occurrence time (year, month) in 
alarm history: 3rd alarm in past - ○ ○ ○

ALM264 Alarm occurrence time (year, month) in 
alarm history: 4th alarm in past - ○ ○ ○

ALM265 Alarm occurrence time (year, month) in 
alarm history: 5th alarm in past - ○ ○ ○

ALM266 Alarm occurrence time (year, month) in 
alarm history: 6th alarm in past - ○ ○ ○

ALM267 Alarm occurrence time (year, month) in 
alarm history: 7th alarm in past - ○ ○ ○

ALM268 Alarm occurrence time (year, month) in 
alarm history: 8th alarm in past - ○ ○ ○

ALM269 Alarm occurrence time (year, month) in 
alarm history: 9th alarm in past - ○ ○ ○

ALM270 Alarm occurrence time (year, month) in 
alarm history: 10th alarm in past - ○ ○ ○

ALM271 Alarm occurrence time (year, month) in 
alarm history: 11th alarm in past - ○ ○ ○

ALM272 Alarm occurrence time (year, month) in 
alarm history: 12th alarm in past - ○ ○ ○

ALM273 Alarm occurrence time (year, month) in 
alarm history: 13th alarm in past - ○ ○ ○

ALM274 Alarm occurrence time (year, month) in 
alarm history: 14th alarm in past - ○ ○ ○

ALM275 Alarm occurrence time (year, month) in 
alarm history: 15th alarm in past - ○ ○ ○

ALM280 Alarm occurrence time (date, hour) in alarm 
history: most recent alarm - ○ ○ ○

ALM281 Alarm occurrence time (date, hour) in alarm 
history: 1st alarm in past - ○ ○ ○

ALM282 Alarm occurrence time (date, hour) in alarm 
history: 2nd alarm in past - ○ ○ ○

ALM283 Alarm occurrence time (date, hour) in alarm 
history: 3rd alarm in past - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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*1 Set [Data Type] and [Format] as shown below for the objects for which this device is set.
• [Data Type]: [Unsigned BIN32]
• [Format]: [Hexadecimal]

ALM284 Alarm occurrence time (date, hour) in alarm 
history: 4th alarm in past - ○ ○ ○

ALM285 Alarm occurrence time (date, hour) in alarm 
history: 5th alarm in past - ○ ○ ○

ALM286 Alarm occurrence time (date, hour) in alarm 
history: 6th alarm in past - ○ ○ ○

ALM287 Alarm occurrence time (date, hour) in alarm 
history: 7th alarm in past - ○ ○ ○

ALM288 Alarm occurrence time (date, hour) in alarm 
history: 8th alarm in past - ○ ○ ○

ALM289 Alarm occurrence time (date, hour) in alarm 
history: 9th alarm in past - ○ ○ ○

ALM290 Alarm occurrence time (date, hour) in alarm 
history: 10th alarm in past - ○ ○ ○

ALM291 Alarm occurrence time (date, hour) in alarm 
history: 11th alarm in past - ○ ○ ○

ALM292 Alarm occurrence time (date, hour) in alarm 
history: 12th alarm in past - ○ ○ ○

ALM293 Alarm occurrence time (date, hour) in alarm 
history: 13th alarm in past - ○ ○ ○

ALM294 Alarm occurrence time (date, hour) in alarm 
history: 14th alarm in past - ○ ○ ○

ALM295 Alarm occurrence time (date, hour) in alarm 
history: 15th alarm in past - ○ ○ ○

ALM300 Alarm occurrence time (minute, second) in 
alarm history: most recent alarm - ○ ○ ○

ALM301 Alarm occurrence time (minute, second) in 
alarm history: 1st alarm in past - ○ ○ ○

ALM302 Alarm occurrence time (minute, second) in 
alarm history: 2nd alarm in past - ○ ○ ○

ALM303 Alarm occurrence time (minute, second) in 
alarm history: 3rd alarm in past - ○ ○ ○

ALM304 Alarm occurrence time (minute, second) in 
alarm history: 4th alarm in past - ○ ○ ○

ALM305 Alarm occurrence time (minute, second) in 
alarm history: 5th alarm in past - ○ ○ ○

ALM306 Alarm occurrence time (minute, second) in 
alarm history: 6th alarm in past - ○ ○ ○

ALM307 Alarm occurrence time (minute, second) in 
alarm history: 7th alarm in past - ○ ○ ○

ALM308 Alarm occurrence time (minute, second) in 
alarm history: 8th alarm in past - ○ ○ ○

ALM309 Alarm occurrence time (minute, second) in 
alarm history: 9th alarm in past - ○ ○ ○

ALM310 Alarm occurrence time (minute, second) in 
alarm history: 10th alarm in past - ○ ○ ○

ALM311 Alarm occurrence time (minute, second) in 
alarm history: 11th alarm in past - ○ ○ ○

ALM312 Alarm occurrence time (minute, second) in 
alarm history: 12th alarm in past - ○ ○ ○

ALM313 Alarm occurrence time (minute, second) in 
alarm history: 13th alarm in past - ○ ○ ○

ALM314 Alarm occurrence time (minute, second) in 
alarm history: 14th alarm in past - ○ ○ ○

ALM315 Alarm occurrence time (minute, second) in 
alarm history: 15th alarm in past - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G
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(17)Specifications of ALM260 to ALM275, ALM280 to ALM295, and ALM300 to ALM315 ([MELSERVO-
J5(W)-*G(-RJ), -JET-*G])
The date and time of alarm occurrence are stored in BCD code in the upper eight bits and lower eight bits of each device.
The time zone setting of the controller is applied to the date and time to be acquired.
Example) When the date and time of the most recent alarm occurrence is 15:30:20 May 15, 2020

When the date and time of alarm occurrence are those of 1999 or earlier, 0 is displayed.

(18)Point table (position) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• POS1 to POS255: Writing data to the RAM of a servo amplifier
• POS1001 to POS1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(19)Point table (speed) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• SPD1 to SPD255: Writing data to the RAM of a servo amplifier
• SPD1001 to SPD1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(20)Point table (acceleration time constant) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• ACT1 to ACT255: Writing data to the RAM of a servo amplifier
• ACT1001 to ACT1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(21)Point table (deceleration time constant) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• DCT1 to DCT255: Writing data to the RAM of a servo amplifier
• DCT1001 to DCT1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

ALM260
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8 ALM280

Date and time of alarm occurrence:     2020 / 5 / 15     15:30:20 (Binary Coded Decimal)

ALM300
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8
Upper 8 bits Lower 8 bits

b7 to b0b15 to b8

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

POS1 to POS255, 
POS1001 to 
POS1255

Point table/position data No. 1 to No. 255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

SPD1 to SPD255, 
SPD1001 to 
SPD1255

Point table/speed data No. 1 to No. 255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ACT1 to ACT255, 
ACT1001 to 
ACT1255

Point table/acceleration time constant No. 1 
to No. 255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

DCT1 to DCT255, 
DCT1001 to 
DCT1255

Point table/deceleration time constant No. 1 
to No. 255 - ○ ○ ○
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(22)Point table (dwell) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• DWL1 to DWL255: Writing data to the RAM of a servo amplifier
• DWL1001 to DWL1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(23)Point table (auxiliary function) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• AUX1 to AUX255: Writing data to the RAM of a servo amplifier
• AUX1001 to AUX1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(24)Point table (M code) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• MCD1 to MCD255: Writing data to the RAM of a servo amplifier
• MCD1001 to MCD1255: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(25)Machine diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

DWL1 to DWL255, 
DWL1001 to 
DWL1255

Point table/dwell No. 1 to No. 255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

AUX1 to AUX255, 
AUX1001 to 
AUX1255

Point table/auxiliary function No. 1 to No. 
255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

MCD1 to MCD255, 
MCD1001 to 
MCD1255

Point table/M code No. 1 to No. 255 - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

MD0 Machine diagnosis data: Station number - ○ ○ ○

MD1 Machine diagnosis data shift judgment(test 
mode) - ○ ○ ○

MD2*1 Machine diagnosis data status - ○ ○ ○

MD3*2 Machine diagnosis data coulomb friction 
torque in positive direction - ○ ○ ○

MD4*2 Machine diagnosis data friction torque at 
rated speed in positive direction - ○ ○ ○

MD5*2 Machine diagnosis data coulomb friction 
torque in negative direction - ○ ○ ○

MD6*2 Machine diagnosis data friction torque at 
rated speed in negative direction - ○ ○ ○

MD7*2 Machine diagnosis data oscillation 
frequency(motor is stopped) - ○ ○ ○

MD8*2 Machine diagnosis data vibration level(motor 
is stopped) - ○ ○ ○

MD9*2 Machine diagnosis data oscillation 
frequency(motor is operating) - ○ ○ ○

MD10*2 Machine diagnosis data vibration level(motor 
is operating) - ○ ○ ○
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*1 While the servo amplifier is estimating the corresponding machine status in the machine diagnosis, do not write data to the 
parameters of the servo amplifier from another GOT.
Doing so may cause the servo amplifier to malfunction.

*2 When MD2 indicates that the servo amplifier does not complete the machine diagnosis (is estimating or warning of the 
machine status), do not monitor MD3 to MD6 (friction states) and MD7 to MD10 (vibration/oscillation states).
To start monitoring those devices upon the estimation completion, set [Trigger] in the applicable object settings.

*3 The commands assigned to MD12 to MD21 are not supported by MR-JET-G.
When the commands are used, the read values will be indefinite.

(26)One-touch tuning data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

*1 Writing is not available when a negative value is set for the device value.

(27)External input signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

MD11 Machine diagnosis data, rated speed at 
forward or reverse rotation torque - ○ ○ ○

MD12 Machine diagnosis data: friction failure 
prediction - threshold creation progress - ○ ○*3 ○

MD13 Machine diagnosis data: vibration failure 
prediction - threshold creation progress - ○ ○*3 ○

MD14 Machine diagnosis data motor total move 
distance - ○ ○*3 ○

MD15

Machine diagnosis data, friction failure 
prediction, upper threshold at forward 
rotation torque, lower threshold at reverse 
rotation torque

- ○ ○*3 ○

MD16

Machine diagnosis data, friction failure 
prediction, lower threshold at forward 
rotation torque, upper threshold at reverse 
rotation torque

- ○ ○*3 ○

MD17 Machine diagnosis data: vibration failure 
prediction - threshold acquisition - ○ ○*3 ○

MD18 Machine diagnosis data trouble prediction 
status - ○ ○*3 ○

MD19 Machine diagnosis data: Belt tension 
estimation value - ○ ○*3 ○

MD20 Machine diagnosis data: static friction used 
in failure prediction - ○ ○*3 ○

MD21 Machine diagnosis data: Belt tension 
threshold estimation - ○ ○*3 ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

OTS0 One-touch tuning status confirmation - ○ ○ ○

OTS1 Error code list - ○ ○ ○

OTS2 Setting time - ○ ○ ○

OTS3 Overshoot amount - ○ ○ ○

OTS4 One-touch tuning command mode - ○ ○ ○

OTS5 Load inertia moment ratio - ○ ○ ○

OTS3000*1 Read/write permissible move distance - ○ ○ ○

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
The input device statuses corresponding to the setting values 0000 to 001F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI1 Input device statuses -
The input device statuses corresponding to the setting values 0020 to 003F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)
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(28)External input signal in MR-J5D□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

(29)External input signal in MR-JET-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

DI2 Input device statuses -
The input device statuses corresponding to the setting values 0040 to 005F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

DI4 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0000 to 001F of the following) 
are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI5 Statuses of input devices switched on through 
communication -

The statuses of input devices switched on through communication (input device 
statuses corresponding to the setting values 0020 to 003F of the following) are 
read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI6 Statuses of input devices switched on through 
communication -

The input device statuses switched on through communications (input device 
statuses corresponding to the setting values 0040 to 005F of the following) are 
read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DI0 Input device statuses -
The input device statuses corresponding to the setting values 0000 to 001F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI1 Input device statuses -
The input device statuses corresponding to the setting values 0020 to 003F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI2 Input device statuses -
The input device statuses corresponding to the setting values 0040 to 005F of the 
following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI3 External input pin statuses -

The statuses of the listed input devices are assigned to the bits in order from bit 
0 and read.
For details on the input devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

DI4 Statuses of input devices switched on through 
communication -

The statuses of the input devices switched on through communication (input 
device statuses corresponding to the setting values 0000 to 001F of the following) 
are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI5 Statuses of input devices switched on through 
communication -

The statuses of input devices switched on through communication (input device 
statuses corresponding to the setting values 0020 to 003F of the following) are 
read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DI6 Statuses of input devices switched on through 
communication -

The input device statuses switched on through communications (input device 
statuses corresponding to the setting values 0040 to 005F of the following) are 
read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

Virtual device name Name Symbol

DI0 Input device statuses -

DI1 Input device statuses -

DI2 Input device statuses -

DI3 External input pin statuses -

DI4 Statuses of input devices switched on through communication -

DI5 Statuses of input devices switched on through communication -

DI6 Statuses of input devices switched on through communication -

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier
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(30)External output signal in MR-J5-G(-RJ) and MR-J5W□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

(31)External output signal in MR-J5D□-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

(32)External output signal in MR-JET-G ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])

(33)Option unit parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PO1 to PO2: Writing data to the RAM of a servo amplifier
• PO1001 to PO1002: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
The output device statuses corresponding to the setting values 8000 to 801F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO1 Output device statuses -
The output device statuses corresponding to the setting values 8020 to 803F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO2 Output device statuses -
The output device statuses corresponding to the setting values 8040 to 805F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

Virtual device 
name Name Symb

ol Data to be read from the servo amplifier

DO0 Output device statuses -
The output device statuses corresponding to the setting values 8000 to 801F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO1 Output device statuses -
The output device statuses corresponding to the setting values 8020 to 803F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO2 Output device statuses -
The output device statuses corresponding to the setting values 8040 to 805F of 
the following are read.
Pr. PF91_Drive recorder Digital channel setting 1 (DRDC1)

DO4 External output pin statuses -

The statuses of the listed output devices are assigned to the bits in order from bit 
0 and read.
For details on the output devices, refer to the following.

➟MR-J5 User's Manual (Hardware)

Virtual device name Name Symbol

DO0 Output device statuses -

DO1 Output device statuses -

DO2 Output device statuses -

DO4 External output pin statuses -

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PO1 to PO2, 
PO1001 to P1002 For manufacturer setting - × × ×
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(34)Special parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PS1 to PS99: Writing data to the RAM of a servo amplifier
• PS1001 to PS1099: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

(35)Linear servo motor/DD motor setting parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PL1 to PL72: Writing data to the RAM of a servo amplifier
• PL1001 to PL1072: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

(36)Multi encoder parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PU1 to PU44: Writing data to the RAM of a servo amplifier
• PU1001 to PU1044: Writing data to the FlashROM or EEPROM of a servo amplifier

○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PS1 to PS99, 
PS1001 to PS1099 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PL1, PL1001 Function selection L-1 **LIT1 ○ × ○

PL2, PL1002 Linear encoder resolution setting Numerator **LIM ○ × ○

PL3, PL1003 Linear encoder resolution setting 
Denominator **LID ○ × ○

PL4, PL1004 Function selection L-2 *LIT2 ○ × ○

PL5, PL1005 Position deviation error detection level LB1 ○ × ○

PL6, PL1006 Speed deviation error detection level LB2 ○ × ○

PL7, PL1007 Torque deviation error detection level LB3 ○ × ○

PL8, PL1008 Function selection L-3 *LIT3 ○ × ○

PL9, PL1009 Magnetic pole detection voltage level LPWM ○ × ○

PL10 to PL16, 
PL1010 to PL1016 For manufacturer setting - × × ×

PL17, PL1017 Mag. pole detn. - Min. pos. detn. meth. - 
Func. sel. LTSTS ○ × ○

PL18, PL1018 Mag.pole detn.-Min.pos.detn.meth.-
Ident.sig.amp. IDLV ○ × ○

PL19 to PL72, 
PL1019 to PL1072 For manufacturer setting - × × ×

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PU1 to PU44, 
PU1001 to PU1044 For manufacturer setting - × × ×
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(37)Positioning control parameters ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Use an appropriate device according to the write destination of the servo amplifier.

• PVS1 to PVS32: Writing data to the RAM of a servo amplifier
• PVS1001 to PVS1032: Writing data to the FlashROM or EEPROM of a servo amplifier

For the parameters prefixed by an asterisk (*), setting becomes effective when the power is turned off once and back on 
after setting the parameter data.
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

PVS1, PVS1001 Profile speed command extension setting PVC2 ○ × ○

PVS2, PVS1002 For manufacturer setting - × × ×

PVS3, PVS1003 Maximum profile speed extension setting MPVCE ○ × ○

PVS4, PVS1004 For manufacturer setting - × × ×

PVS5, PVS1005 Profile acceleration PACC ○ × ○

PVS6, PVS1006 For manufacturer setting - × × ×

PVS7, PVS1007 Profile deceleration PDEC ○ × ○

PVS8, PVS1008 For manufacturer setting - × × ×

PVS9, PVS1009 Forced stop deceleration RSBDEC ○ ○ ○

PVS10, PVS1010 For manufacturer setting - × × ×

PVS11, PVS1011 Home position return speed extension 
setting ZRFE ○ ○ ○

PVS12, PVS1012 For manufacturer setting - × × ×

PVS13, PVS1013 Creep speed extension setting CRFE ○ ○ ○

PVS14, PVS1014 For manufacturer setting - × × ×

PVS15, PVS1015 Home position return acceleration HMACC ○ ○ ○

PVS16, PVS1016 For manufacturer setting - × × ×

PVS17, PVS1017 Home position return deceleration HMDEC ○ ○ ○

PVS18, PVS1018 For manufacturer setting - × × ×

PVS19, PVS1019 Speed reached 2 output range extension 
setting SA2RE ○ × ○

PVS20, PVS1020 Zero speed 2 level extension setting ZSP2LE ○ × ○

PVS21, PVS1021 Speed limit extension setting VLMTE ○ ○ ○

PVS22, PVS1022 For manufacturer setting - × × ×

PVS23, PVS1023 Speed unit conversion electronic gear 
numerator *VCMX ○ ○ ○

PVS24, PVS1024 Speed unit conversion electronic gear 
denominator *VCDV ○ ○ ○

PVS25, PVS1025 Acceleration unit conversion electronic gear 
nmrtr. *ACMX ○ ○ ○

PVS26, PVS1026 Acceleration unit conversion electronic gear 
dnmntr. *ACDV ○ ○ ○

PVS27 to PVS28, 
PVS1027 to 
PVS1028

For manufacturer setting - × × ×

PVS29, PVS1029 Acceleration limit ACCLMT × × ○

PVS30, PVS1030 For manufacturer setting - × × ×

PVS31, PVS1031 Deceleration limit DECLMT × × ○

PVS32, PVS1032 For manufacturer setting - × × ×
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(38)Network basic parameter ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
Set [Data Type] and [Format] as shown below for the objects for which this device is set.

• [Data Type]: [Unsigned BIN32]
• [Format]: [Hexadecimal]

○: Available
×: Not available

(39)Gear failure diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

(40)Encoder communication circuit diagnosis data ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

(41)Life Diagnosis ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

NPA1 IP address setting - ○ ○ ○

NPA2 IP address - ○ ○ ○

NPA3 For manufacturer setting - × × ×

NPA4 Subnet mask - ○ ○ ○

NPA5 to NPA7 For manufacturer setting - × × ×

NPA8 Host name - ○ ○ ○

NPA9 to NPA11 For manufacturer setting - × × ×

NPA12 Communication speed - × × ○

NPA2001 to 
NPA2032 Host name expansion area - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

GFDS0 Backlash estimation (threshold) - ○ × ○

GFDS1 Backlash estimation (estimation value) - ○ × ○

GFDS2 Backlash estimation (estimation progress) - ○ × ○

GFDS3 Backlash estimation (status) - ○ × ○

GFDS4 Backlash error number - ○ × ○

GFDS5 Backlash estimation move distance - ○ × ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ECCDS0 CN2 encoder communication circuit 
diagnosis possibility - ○ ○ ○

ECCDS1 CN2L encoder communication circuit 
diagnosis possibility - ○ ○ ○

ECCDS2 CN2 encoder communication circuit 
diagnosis status - ○ ○ ○

ECCDS3 CN2L encoder communication circuit 
diagnosis status - ○ ○ ○

ECCDS4 CN2 encoder communication circuit 
diagnosis result - ○ ○ ○

ECCDS5 CN2L encoder communication circuit 
diagnosis result - ○ ○ ○

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

ALD0 Cumulative power-on time - ○ ○ ○

ALD1 Number of inrush current switching times - ○ ○ ○
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(42)Input signal for test operation (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the input signal for test operation (for test operation), note the following.

(43)Forced output of signal pin (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

When using the forced output of signal pin (for test operation), note the following.

(44)Set data (for test operation) ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
○: Available
×: Not available

■8 Precautions for virtual servo amplifier devices ([MELSERVO-J5(W)-*G(-RJ), -JET-*G])
For the precautions for virtual servo amplifier devices, refer to the following.

➟12.3.2 ■11 Precautions for virtual servo amplifier devices ([MELSEC iQ-R, RnMT/NC/RT, CR800-D], 
[MELSEC iQ-R, RnMT/RT, CR800-D])

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

TMI0 Input signal for test operation - ○ ○ ○

TMI1 Input signal for test operation - ○ ○ ○

TMI2 For manufacturer setting - × × ×

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

TMO0 Forced output of signal pin - ○ ○ ○

Precautions Description

Writing a value to a virtual device using an object
Numerical input cannot be used.
Use a word switch for writing.

Virtual device name Name Symbol MR-J5-G(-RJ), MR-J5W□-G MR-JET-G MR-J5D□-G

TMD0 Motor speed - ○ ○ ○

TMD1 Write acceleration/deceleration time 
constant - ○ ○ ○

TMD3 Move distance - ○ ○ ○
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12.3.23 [FREQROL 500/700/800, SENSORLESS SERVO]

■1 Monitoring-supported bit devices ([FREQROL 500/700/800, SENSORLESS SERVO])
The following table shows monitoring-supported virtual bit devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.23 ■2 Availability of writing/reading data to/from bit devices ([FREQROL 500/700/800, SENSORLESS 
SERVO])

For details on virtual inverter devices, refer to the following.
➟12.3.23 ■5 Virtual inverter devices ([FREQROL 500/700/800, SENSORLESS SERVO])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([FREQROL 500/700/800, 
SENSORLESS SERVO])

The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Item Reference

Specifications of bit devices

➟■1 Monitoring-supported bit devices ([FREQROL 500/700/800, SENSORLESS SERVO])

➟■2 Availability of writing/reading data to/from bit devices ([FREQROL 500/700/800, SENSORLESS 
SERVO])

Specifications of word devices

➟■3 Monitoring-supported word devices ([FREQROL 500/700/800, SENSORLESS SERVO])

➟■4 Availability of writing/reading data to/from word devices ([FREQROL 500/700/800, SENSORLESS 
SERVO])

Specifications of virtual inverter 
devices ➟■5 Virtual inverter devices ([FREQROL 500/700/800, SENSORLESS SERVO])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

RS Inverter status monitor Decimal 0 to 15 × ×

WS Operation command Decimal 0 to 15 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

RS R/- -/- -/- -/- -/-

WS -/W -/- -/- -/- -/-
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■3 Monitoring-supported word devices ([FREQROL 500/700/800, SENSORLESS SERVO])
The following table shows monitoring-supported virtual word devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.23 ■4 Availability of writing/reading data to/from word devices ([FREQROL 500/700/800, 
SENSORLESS SERVO])

For details on virtual inverter devices, refer to the following.
➟12.3.23 ■5 Virtual inverter devices ([FREQROL 500/700/800, SENSORLESS SERVO])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■4 Availability of writing/reading data to/from word devices ([FREQROL 500/700/800, 
SENSORLESS SERVO])

The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for SP111 to SP114.
Only writing is available for SP124 and SP125.

■5 Virtual inverter devices ([FREQROL 500/700/800, SENSORLESS SERVO])
The following shows the correspondence between the virtual devices used in the GOT and the inverter data.
For details on the inverter parameters, refer to the following.

➟Manual of the inverter used

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

A Alarm definition Decimal 0 to 7 ○ ×

Pr Parameter Decimal 0 to 1500 ○ ×

PG Program operation Decimal 0 to 89 ○ ×

SP Special parameter Decimal 108 to 127 ○ ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

A R/- -/- -/- -/-

Pr R/W -/- -/- -/-

PG R/W -/- -/- -/-

SP*1 R/W -/- -/- -/-

Virtual device name Reference

RS ➟(1) Inverter status monitor ([FREQROL 500/700/800, SENSORLESS SERVO])

WS
➟(2) Operation command ([FREQROL 500/700/800, SENSORLESS SERVO])

➟(3) Activating WS devices ([FREQROL 500/700/800, SENSORLESS SERVO])

A ➟(4) Alarm definition ([FREQROL 500/700/800, SENSORLESS SERVO])

Pr ➟(5) Parameter ([FREQROL 500/700/800, SENSORLESS SERVO])

PG ➟(6) Programmed operation ([FREQROL 500/700/800, SENSORLESS SERVO])

SP
➟(7) Special parameter ([FREQROL 500/700/800, SENSORLESS SERVO])

➟(8) Specifications of SP122 and SP121([FREQROL 500/700/800, SENSORLESS SERVO])
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(1) Inverter status monitor ([FREQROL 500/700/800, SENSORLESS SERVO])
The settable devices vary by inverter model.
For the settable devices of each inverter, refer to the following.

➟Manual of the inverter used
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

Example) When using the FR-A700 series

(2) Operation command ([FREQROL 500/700/800, SENSORLESS SERVO])
The settable devices vary by inverter model.
For the settable devices of each inverter, refer to the following.

➟Manual of the inverter used
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

Example) When using the FR-A700 series

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the multispeed 
operation (WS3 to WS7, SP121, SP122) cannot be used.
For using the multi-speed operation, follow either of the operations below.

• Connect the GOT to the RS-485 terminal and set the operation mode to the NET operation mode (Computer link 
operation mode), and then operate the inverter.

• Change the motor speed with the set frequency (SP109, SP110), and then operate the inverter with the forward or 
reverse rotation (WS1, WS2, SP121, SP122).

*2 The initial status is invalid.
The virtual device becomes operable by writing a value in the corresponding parameter shown below to change the signal.

• WS8: Pr.185
• WS9: Pr.186
• WS10: Pr.188

Virtual device name Name

RS0 Inverter running (RUN)

RS1 Forward rotation (STF)

RS2 Reverse rotation (STR)

RS3 Up to frequency (SU)

RS4 Overload (OL)

RS5 Instantaneous power failure (IPF)

RS6 Frequency detection (FU)

RS7 Fault occurrence (ABC1)

RS8 ABC2

RS15 Fault occurrence

Virtual device name Name

WS0 Current input selection (AU)

WS1 Forward rotation (STF)

WS2 Reverse rotation (STR)

WS3*1 Low speed operation (RL)

WS4*1 Middle speed operation (RM)

WS5*1 High speed operation (RH)

WS6*1 Second function selection (RT)

WS7*1 Output stop (MRS)

WS8*2 JOG operation (JOG)

WS9*2 Selection of automatic restart after instantaneous power failure (CS)

WS10*2 Start self-holding selection (STOP)

WS11*2 Reset (RES)
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• WS11: Pr.189
For the relationship between the parameter values and signals, refer to the following.
➟Manual of the inverter used

When using the operation command, note the following.

(3) Activating WS devices ([FREQROL 500/700/800, SENSORLESS SERVO])
More than one WS device cannot turn on at once.
Turning on one WS device turns off the other WS devices.
Use SP122 or SP121 to turn on multiple WS devices simultaneously.

➟12.3.23 ■5 (8) Specifications of SP122 and SP121([FREQROL 500/700/800, SENSORLESS SERVO])
The following shows the specifications of WS devices.

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

When activating WS devices ➟12.3.23 ■5 (3) Activating WS devices ([FREQROL 500/700/800, SENSORLESS SERVO])

WS device Specifications

WS0 to WS7

GOT's virtual devices corresponding to the inverter's operation commands (instruction code: HFA, bit length: 8 bits)

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• WS0: AU (Terminal 4 input selection)
• WS1: Forward rotation command
• WS2: Reverse rotation command
• WS3: RL (Low-speed operation command)
• WS4: RM (Middle-speed operation command)
• WS5: RH (High-speed operation command)
• WS6: RT (Second function selection)
• WS7: MRS (Output stop)

When you turn on one of the WS0 to WS7 devices, the rest of these devices are turned off.
Example) When you turn on WS1
WS0 and WS2 to WS7 are turned off.

WS8 to WS15

WS8 to WS11 are GOT's virtual devices corresponding to the inverter's operation commands (extended) (instruction code: 
HF9, bit length: 16 bits).

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• WS8: JOG (Jog operation selection)
• WS9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• WS10: STOP (Start self-holding selection)
• WS11: RES (Inverter reset)

Turning on a device out of WS8 to WS11 turns off WS0 to WS15 except the one that is turned on.
Example) When you turn on WS9
WS0 to WS8 and WS10 to WS15 are turned off.

Operation command
b7 b0
0 0 0 0 0 0 0 0

WS0
WS1
WS2
WS3
WS4
WS5
WS6
WS7

Operation command (extended)
b15 b7 b0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Fixed to 0
WS8
WS9
WS10
WS11
Not used
12 - 458 12. APPENDICES
12.3 Device Range and Settings of Mitsubishi Electric Equipment



A
PP

EN
D

IC
ES

12
(4) Alarm definition ([FREQROL 500/700/800, SENSORLESS SERVO])
The settable devices vary by inverter model.
For the settable devices of each inverter, refer to the following.

➟Manual of the inverter used

(5) Parameter ([FREQROL 500/700/800, SENSORLESS SERVO])
The virtual device numbers (Pr) used in the GOT correspond to the inverter parameter numbers.
For the inverter parameters, refer to the following.

➟Manual of the inverter used
When using a parameter, note the following.

(6) Programmed operation ([FREQROL 500/700/800, SENSORLESS SERVO])
The virtual devices below correspond to the parameters (Pr.201 to Pr.230) of the FR-A500 series.

*1 To set the start time (PG10 to PG19, PG40 to PG49, PG70 to PG79), set hour or minute in the upper 8 bits, and minute or 
second in the lower 8 bits.
Example) To set 12 minutes 35 seconds

• Value written to the upper 8 bits: H0C (hexadecimal value of 12)
• Value written to the lower 8 bits: H23 (hexadecimal value of 35)

Virtual device name Name

A0 Second fault in past

A1 Latest fault

A2 Fourth fault in past

A3 Third fault in past

A4 Sixth fault in past

A5 Fifth fault in past

A6 Eighth fault in past

A7 Seventh fault in past

Precautions Description

When creating a screen using a parameter (Pr)
Specify a PG device (Programmed operation) or Pr device (Parameter).
Do not specify PG devices (PG0 to PG89) and Pr devices (Pr900 to Pr905) together on one 
screen.

When setting 8888 or 9999 to a parameter (Pr) 
of an inverter

Values 8888 and 9999 are used for particular purposes.
To set these values to inverter parameters, write the following values to the GOT virtual device.
• To set 8888: 65520
• To set 9999: 65535

When specifying Pr900 to Pr933 (Calibration 
parameter) or Pr934 and Pr935 (PID display)

If you specify Pr900 to Pr933 (Calibration parameter), or Pr934 and Pr935 (PID display), 
whether the value below must be written to SP108 (Second parameter changing) depends on 
the specified device number and inverter model.
• H00: Offset/gain
• H01: Analog
• H02: Analog value at terminal

Parameters that cannot be monitored The GOT cannot monitor the parameter (Pr.37) of FR-E500, FR-S500(E), FR-F500J, FR-D700, 
FR-F700PJ, and FR-E700 series.

Virtual device name Name

PG0 to PG9 Program set 1 (running frequency)

PG10 to PG19*1 Program set 1 (time)

PG20 to PG29 Program set 1 (rotation direction)

PG30 to PG39 Program set 2 (running frequency)

PG40 to PG49*1 Program set 2 (time)

PG50 to PG59 Program set 2 (rotation direction)

PG60 to PG69 Program set 3 (running frequency)

PG70 to PG79*1 Program set 3 (time)

PG80 to PG89 Program set 3 (rotation direction)
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Write H0C23 (decimal value: 3107) to the device.
When using the programmed operation, note the following.

(7) Special parameter ([FREQROL 500/700/800, SENSORLESS SERVO])
If the GOT reads or writes data from or to a virtual device (SP), the inverter's instruction code corresponding to the SP 
device is used for communication.
For instruction details, and values to be read and written, refer to the following.

➟Manual of the inverter used

*1 GOT cannot monitor SP109 to SP111 if the conditions below are satisfied at the same time.
(Only FR-E500/S500(E)/F500J/D700/F700PJ/E700 series)

• Pr37 ≠ 0
• SP127 = 1

*2 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the multispeed 
operation (WS3 to WS7, SP121, SP122) cannot be used.
For using the multi-speed operation, follow either of the operations below.

• Connect the GOT to the RS-485 terminal and set the operation mode to the NET operation mode (Computer link 
operation mode), and then operate the inverter.

• Change the motor speed with the set frequency (SP109, SP110), and then operate the inverter with the forward or 
reverse rotation (WS1, WS2, SP121, SP122).

*3 For the specifications of SP122 and SP121, refer to the following.

➟12.3.23 ■5 (8) Specifications of SP122 and SP121([FREQROL 500/700/800, SENSORLESS SERVO])
*4 If the GOT is connected to the PU port of the FR-A500/E500/F500 (excluding the FR-F500J), the connected inverter is in 

the external operation mode at power-on.
To change parameters from the GOT, change the value of SP123 to 2 (PU operation mode) in advance.

Precautions Description

When creating a screen using the programmed 
operation (PG)

Specify a PG device (Programmed operation) or Pr device (Parameter).
Do not specify PG devices (PG0 to PG89) and Pr devices (Pr900 to Pr905) together on one 
screen.

Virtual device name Name
Instruction code

Read Writing

SP108 Second parameter changing 6CH ECH

SP109*1 Set frequency (RAM) 6DH EDH

SP110*1 Set frequency (RAM, EEPROM) 6EH EEH

SP111*1 Output frequency 6FH -

SP112 Output current 70H -

SP113 Output voltage 71H -

SP114 Special monitor 72H -

SP115 Special monitor selection No. 73H F3H

SP116
Faults history batch clear - F4H

Latest fault, Second fault in past 74H -

SP117 Third fault in past, Fourth fault in past 75H -

SP118 Fifth fault in past, Sixth fault in past 76H -

SP119 Seventh fault in past, Eighth fault in past 77H -

SP121*2*3
Inverter status monitor (extended)

79H F9H
Operation command (extended)

SP122*2*3
Inverter status monitor 7AH -

Operation command - FAH

SP123*4 Operation mode 7BH FBH

SP124 All parameter clear - FCH

SP125 Inverter reset - FDH

SP127 Link parameter extended setting 7FH FFH
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(8) Specifications of SP122 and SP121([FREQROL 500/700/800, SENSORLESS SERVO])
SP122 and SP121 are the GOT's virtual devices corresponding to the inverter's ordinary and extended operation 
commands.
The following shows the specifications of SP122 and SP121.

SP device Specifications

SP122

GOT's virtual device corresponding to the inverter's operation command (instruction code: HFA, bit length: 8 bits)
The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP122.b0: AU (Terminal 4 input selection)
• SP122.b1: Forward rotation command
• SP122.b2: Reverse rotation command
• SP122.b3: RL (Low-speed operation command)
• SP122.b4: RM (Middle-speed operation command)
• SP122.b5: RH (High-speed operation command)
• SP122.b6: RT (Second function selection)
• SP122.b7: MRS (Output stop)

To send more than one command simultaneously, convert the binary value of the bits to be turned on to a decimal value, 
and write the decimal value to SP122.
Example) Sending forward rotation command and RL (Low-speed operation command) simultaneously
Binary: 00001010
Decimal: 10
Write 10 to SP122.

SP121

GOT's virtual device corresponding to the inverter's operation commands (instruction code: HF9, bit length: 16 bits)
The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP121.b0: AU (Terminal 4 input selection)
• SP121.b1: Forward rotation command
• SP121.b2: Reverse rotation command
• SP121.b3: RL (Low-speed operation command)
• SP121.b4: RM (Middle-speed operation command)
• SP121.b5: RH (High-speed operation command)
• SP121.b6: RT (Second function selection)
• SP121.b7: MRS (Output stop)
• SP121.b8: JOG (Jog operation selection)
• SP121.b9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• SP121.b10: STOP (Start self-holding selection)
• SP121.b11: RES (Inverter reset)
• SP121.b12 to SP122.b15: Not used

To send more than one command simultaneously, convert the binary value of the device (with applicable bits on) to a 
decimal value, and write the decimal value to SP121.
Example) Sending forward rotation command, RL (Low-speed operation command), and JOG (Jog operation selection) 
simultaneously
Binary: 0000000100001010
Decimal: 266
Write 266 to SP121.
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12.3.24 [FREQROL 800]

When [Automatic Negotiation] is set to [Yes] in the GOT communication settings, the inverter parameters are 
reconfigured within the user-specified negotiation time.
If the automatic connection fails, set the longer negotiation time with GT Designer3 or the utility.

■1 Monitoring-supported bit devices ([FREQROL 800])
The following table shows monitoring-supported virtual bit devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.24 ■2 Availability of writing/reading data to/from bit devices ([FREQROL 800])
For details on virtual inverter devices, refer to the following.

➟12.3.24 ■5 Virtual inverter devices ([FREQROL 800])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Functions are assigned to the SM devices by using the PLC function.

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([FREQROL 800])

➟■2 Availability of writing/reading data to/from bit devices ([FREQROL 800])

Specifications of word devices
➟■3 Monitoring-supported word devices ([FREQROL 800])

➟■4 Availability of writing/reading data to/from word devices ([FREQROL 800])

Specifications of virtual inverter 
devices ➟■5 Virtual inverter devices ([FREQROL 800])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

RS Inverter status monitor Decimal 0 to 15 × ×

WS Operation command Decimal 0 to 15 × ×

X Input Hexadeci
mal 00 to 7F ○ ○

Y Output Hexadeci
mal 00 to 7F ○ ○

M Internal relay Decimal 0 to 127 ○ ○

TC Timer coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

TT Timer contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

CC Counter coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

CT Counter contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

SC Retentive timer coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

SS Retentive timer contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

SM*2 Special relay Decimal 0 to 2047 ○ ○
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Do not write data from the GOT.

■2 Availability of writing/reading data to/from bit devices ([FREQROL 800])
The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([FREQROL 800])
The following table shows monitoring-supported virtual word devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.24 ■4 Availability of writing/reading data to/from word devices ([FREQROL 800])
For details on virtual inverter devices, refer to the following.

➟12.3.24 ■5 Virtual inverter devices ([FREQROL 800])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

RS R/- -/- -/- -/- -/-

WS -/W -/- -/- -/- -/-

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SM R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

A Alarm definition Decimal 0 to 7 ○ ○

Pr Parameter Decimal 0 to 1500 ○ ○

SP Special parameter Decimal 108 to 127 ○ ○

TN Timer current value Decimal 0 to 15 ○ ○

CN Counter current value Decimal 0 to 15 ○ ○

SN Retentive timer current value Decimal 0 to 15 ○ ○

D Data register Decimal 0 to 255 ○ ○

SD Special register Decimal 0 to 2047 ○ ○
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■4 Availability of writing/reading data to/from word devices ([FREQROL 800])
The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for SP111 to SP114 and SP117 to SP119.
Only writing is available for SP124 and SP125.

■5 Virtual inverter devices ([FREQROL 800])
The following shows the correspondence between the virtual devices used in the GOT and the inverter data.
For details on the inverter parameters, refer to the following.

➟Manual of the inverter used

(1) Inverter status monitor ([FREQROL 800])
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

➟Manual of the inverter used

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

A R/- -/- -/- -/-

Pr R/W -/- -/- -/-

SP*1 R/W -/- -/- -/-

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W -/- R/W

SD R/W R/W -/- R/W

Virtual device name Reference

RS ➟(1) Inverter status monitor ([FREQROL 800])

WS
➟(2) Operation command ([FREQROL 800])

➟(3) Activating WS devices ([FREQROL 800])

A ➟(4) Alarm definition ([FREQROL 800])

Pr ➟(5) Parameter ([FREQROL 800])

SP
➟(6) Special parameter ([FREQROL 800])

➟(7) Specifications of SP122 and SP121 ([FREQROL 800])

Virtual device name Name

RS0 RUN (Inverter running)

RS1 During forward rotation

RS2 During reverse rotation

RS3 SU (Up to frequency)

RS4 OL (Overload warning)

RS5 IPF (Instantaneous power failure/undervoltage)

RS6 FU (Output frequency detection)

RS7 ABC1 (Fault)

RS8 ABC2

RS9 Safety monitor output

RS15 Fault occurrence
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(2) Operation command ([FREQROL 800])
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

➟Manual of the inverter used

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the relevant setting in Pr.180 to Pr.189 (input terminal function selection).

When using the operation command, note the following.

(3) Activating WS devices ([FREQROL 800])
More than one WS device cannot turn on at once.
Turning on one WS device turns off the other WS devices.
Use SP122 or SP121 to turn on multiple WS devices simultaneously.

Virtual device name Name

WS0*1*2 AU (Terminal 4 input selection)

WS1 Forward rotation command

WS2 Reverse rotation command

WS3*1*2 RL (Low-speed operation command)

WS4*1*2 RM (Middle-speed operation command)

WS5*1*2 RH (High-speed operation command)

WS6*1*2 RT (Second function selection)

WS7*1*2 MRS (Output stop)

WS8*1*2*3 JOG (Jog operation selection)

WS9*1*2*3 CS (Selection of automatic restart after instantaneous power failure, flying start)

WS10*1*2*3 STOP (Start self-holding selection)

WS11*1*2*3 RES (Inverter reset)

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

When activating WS devices ➟12.3.24 ■5 (3) Activating WS devices ([FREQROL 800])
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➟12.3.24 ■5 (7) Specifications of SP122 and SP121 ([FREQROL 800])
The following shows the specifications of WS devices.

(4) Alarm definition ([FREQROL 800])

WS device Specifications

WS0 to WS7

GOT's virtual devices corresponding to the inverter's operation commands (instruction code: HFA, bit length: 8 bits)

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• WS0: AU (Terminal 4 input selection)
• WS1: Forward rotation command
• WS2: Reverse rotation command
• WS3: RL (Low-speed operation command)
• WS4: RM (Middle-speed operation command)
• WS5: RH (High-speed operation command)
• WS6: RT (Second function selection)
• WS7: MRS (Output stop)

When you turn on one of the WS0 to WS7 devices, the rest of these devices are turned off.
Example) When you turn on WS1
WS0 and WS2 to WS7 are turned off.

WS8 to WS15

WS8 to WS11 are GOT's virtual devices corresponding to the inverter's operation commands (extended) (instruction code: 
HF9, bit length: 16 bits).

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• WS8: JOG (Jog operation selection)
• WS9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• WS10: STOP (Start self-holding selection)
• WS11: RES (Inverter reset)

Turning on a device out of WS8 to WS11 turns off WS0 to WS15 except the one that is turned on.
Example) When you turn on WS9
WS0 to WS8 and WS10 to WS15 are turned off.

Operation command
b7 b0
0 0 0 0 0 0 0 0

WS0
WS1
WS2
WS3
WS4
WS5
WS6
WS7

Operation command (extended)
b15 b7 b0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Fixed to 0
WS8
WS9
WS10
WS11
Not used

Virtual device name Name

A0 Second fault in past

A1 Latest fault

A2 Fourth fault in past

A3 Third fault in past

A4 Sixth fault in past

A5 Fifth fault in past

A6 Eighth fault in past

A7 Seventh fault in past
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(5) Parameter ([FREQROL 800])
The virtual device numbers (Pr) used in the GOT correspond to the inverter parameter numbers.
For the inverter parameters, refer to the following.

➟Manual of the inverter used
When using a parameter, note the following.

(6) Special parameter ([FREQROL 800])
If the GOT reads or writes data from or to a virtual device (SP), the inverter's instruction code corresponding to the SP 
device is used for communication.
For instruction details, and values to be read and written, refer to the following.

➟Manual of the inverter used

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the multispeed 
operation (WS3 to WS7, SP121, SP122) cannot be used.
For using the multi-speed operation, follow either of the operations below.

• Connect the GOT to the RS-485 terminal and set the operation mode to the NET operation mode (Computer link 
operation mode), and then operate the inverter.

• Change the motor speed with the set frequency (SP109, SP110), and then operate the inverter with the forward or 
reverse rotation (WS1, WS2, SP121, SP122).

*2 For the specifications of SP122 and SP121, refer to the following.

➟12.3.24 ■5 (7) Specifications of SP122 and SP121 ([FREQROL 800])

Precautions Description

When setting 8888 or 9999 to a parameter (Pr) 
of an inverter

Values 8888 and 9999 are used for particular purposes.
To set these values to inverter parameters, write the following values to the GOT virtual device.
• To set 8888: 65520
• To set 9999: 65535

When specifying Pr900 to Pr933 (Calibration 
parameter) or Pr934 and Pr935 (PID display)

If you specify Pr900 to Pr933 (Calibration parameter), or Pr934 and Pr935 (PID display), 
whether the value below must be written to SP108 (Second parameter changing) depends on 
the specified device number and inverter model.
• H00: Offset/gain
• H01: Analog
• H02: Analog value at terminal

Virtual device name Name
Instruction code

Read Writing

SP108 Second parameter changing 6CH ECH

SP109 Set frequency (RAM) 6DH EDH

SP110 Set frequency (RAM, EEPROM) 6EH EEH

SP111 Output frequency/speed 6FH -

SP112 Output current 70H -

SP113 Output voltage 71H -

SP114 Special monitor 72H -

SP115 Special monitor selection No. 73H F3H

SP116
Faults history batch clear - F4H

Latest fault, Second fault in past 74H -

SP117 Third fault in past, Fourth fault in past 75H -

SP118 Fifth fault in past, Sixth fault in past 76H -

SP119 Seventh fault in past, Eighth fault in past 77H -

SP121*1*2
Inverter status monitor (extended)

79H F9H
Operation command (extended)

SP122*1*2
Inverter status monitor 7AH -

Operation command - FAH

SP123 Operation mode 7BH FBH

SP124 All parameter clear - FCH

SP125 Inverter reset - FDH

SP127 Link parameter extended setting 7FH FFH
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(7) Specifications of SP122 and SP121 ([FREQROL 800])
SP122 and SP121 are the GOT's virtual devices corresponding to the inverter's ordinary and extended operation 
commands.
The following shows the specifications of SP122 and SP121.

SP device Specifications

SP122

GOT's virtual device corresponding to the inverter's operation command (instruction code: HFA, bit length: 8 bits)
The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP122.b0: AU (Terminal 4 input selection)
• SP122.b1: Forward rotation command
• SP122.b2: Reverse rotation command
• SP122.b3: RL (Low-speed operation command)
• SP122.b4: RM (Middle-speed operation command)
• SP122.b5: RH (High-speed operation command)
• SP122.b6: RT (Second function selection)
• SP122.b7: MRS (Output stop)

To send more than one command simultaneously, convert the binary value of the bits to be turned on to a decimal value, 
and write the decimal value to SP122.
Example) Sending forward rotation command and RL (Low-speed operation command) simultaneously
Binary: 00001010
Decimal: 10
Write 10 to SP122.

SP121

GOT's virtual device corresponding to the inverter's operation commands (instruction code: HF9, bit length: 16 bits)
The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP121.b0: AU (Terminal 4 input selection)
• SP121.b1: Forward rotation command
• SP121.b2: Reverse rotation command
• SP121.b3: RL (Low-speed operation command)
• SP121.b4: RM (Middle-speed operation command)
• SP121.b5: RH (High-speed operation command)
• SP121.b6: RT (Second function selection)
• SP121.b7: MRS (Output stop)
• SP121.b8: JOG (Jog operation selection)
• SP121.b9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• SP121.b10: STOP (Start self-holding selection)
• SP121.b11: RES (Inverter reset)
• SP121.b12 to SP122.b15: Not used

To send more than one command simultaneously, convert the binary value of the device (with applicable bits on) to a 
decimal value, and write the decimal value to SP121.
Example) Sending forward rotation command, RL (Low-speed operation command), and JOG (Jog operation selection) 
simultaneously
Binary: 0000000100001010
Decimal: 266
Write 266 to SP121.
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12.3.25 [FREQROL 800/E700NE(Batch monitor)]

■1 Monitoring-supported bit devices ([FREQROL 800/E700NE(Batch monitor)])
The following table shows monitoring-supported virtual bit devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.25 ■2 Availability of writing/reading data to/from bit devices ([FREQROL 800/E700NE(Batch monitor)])
For details on virtual inverter devices, refer to the following.

➟12.3.25 ■7 Virtual inverter devices ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([FREQROL 800/E700NE(Batch monitor)])

➟■2 Availability of writing/reading data to/from bit devices ([FREQROL 800/E700NE(Batch monitor)])

Specifications of word devices
➟■3 Monitoring-supported word devices ([FREQROL 800/E700NE(Batch monitor)])

➟■4 Availability of writing/reading data to/from word devices ([FREQROL 800/E700NE(Batch monitor)])

Specifications of double-word 
devices

➟■5 Monitoring-supported double-word devices ([FREQROL 800/E700NE(Batch monitor)])

➟■6 Availability of writing/reading data to/from double-word devices ([FREQROL 800/E700NE(Batch 
monitor)])

Specifications of virtual inverter 
devices ➟■7 Virtual inverter devices ([FREQROL 800/E700NE(Batch monitor)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

RS Inverter status monitor Decimal 0 to 15 × ×

WS Operation command Decimal 0 to 15 × ×

IOST I/O terminal monitor Decimal 0 to 127 × ×

CMD Operation command Decimal 0 to 63 × ×

X*2 Input Hexadeci
mal 00 to 7F ○ ○

Y*2 Output Hexadeci
mal 00 to 7F ○ ○

M*2 Internal relay Decimal 0 to 127 ○ ○

TC*2 Timer coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

TT*2 Timer contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

CC*2 Counter coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

CT*2 Counter contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

SC*2 Retentive timer coil Decimal 0 to 15 ○
○
(Not usable as 
word data)

SS*2 Retentive timer contact Decimal 0 to 15 ○
○
(Not usable as 
word data)

SM*2*3 Special relay Decimal 0 to 2047 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Not available to FR-E7□0-NE.
*3 Functions are assigned to the SM devices by using the PLC function.

Do not write data from the GOT.

■2 Availability of writing/reading data to/from bit devices ([FREQROL 800/E700NE(Batch 
monitor)])

The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([FREQROL 800/E700NE(Batch monitor)])
The following table shows monitoring-supported virtual word devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.25 ■4 Availability of writing/reading data to/from word devices ([FREQROL 800/E700NE(Batch 
monitor)])

For details on virtual inverter devices, refer to the following.
➟12.3.25 ■7 Virtual inverter devices ([FREQROL 800/E700NE(Batch monitor)])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

RS R/- -/- -/- -/- -/-

WS -/W -/- -/- -/- -/-

IOST R/- -/- -/- -/- -/-

CMD -/W -/- -/- -/- -/-

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TT R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

SC R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

SM R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

A Alarm definition Decimal 0 to 7 ○ ○

Pr Parameter Decimal 0 to 1500 ○ ○

SP Special parameter Decimal 108 to 127 ○ ○

TN*2 Timer current value Decimal 0 to 15 ○ ○

CN*2 Counter current value Decimal 0 to 15 ○ ○

SN*2 Retentive timer current value Decimal 0 to 15 ○ ○

D*2 Data register Decimal 0 to 255 ○ ○

SD*2 Special register Decimal 0 to 2047 ○ ○
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*2 Not available to FR-E7□0-NE.

■4 Availability of writing/reading data to/from word devices ([FREQROL 800/E700NE(Batch 
monitor)])

The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for SP111 to SP114 and SP117 to SP119.
Only writing is available for SP124 and SP125.

■5 Monitoring-supported double-word devices ([FREQROL 800/E700NE(Batch monitor)])
The following table shows monitoring-supported virtual double-word devices for inverters.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.25 ■6 Availability of writing/reading data to/from double-word devices ([FREQROL 800/E700NE(Batch 
monitor)])

For details on virtual inverter devices, refer to the following.
➟12.3.25 ■7 Virtual inverter devices ([FREQROL 800/E700NE(Batch monitor)])

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 If you specify LPr900 to LPr935, the following item is displayed in the device setting dialog.

• [Setting items (for calibration parameters)]: [Bias/gain value], [Analog input value]
Enclose the device number in parentheses when selecting [Analog input value].
Example 1) Notation when [Bias/gain value] is selected: LPr900
Example 2) Notation when [Analog input value] is selected: LPr(900)
When LPr900 or LPr901 (Calibration parameter) is specified, selecting [Bias/gain value] or [Analog input value] does not 
affect the monitoring target.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

A R/- -/- -/- -/-

Pr R/W -/- -/- -/-

SP*1 R/W -/- -/- -/-

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

SN R/W R/W -/- -/-

D R/W R/W -/- R/W

SD R/W R/W -/- R/W

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

AL Faults history Decimal 0 to 899 × ×

LPr*2 Parameter (32-bit) Decimal 0 to 1500 × ×

OP Operation parameters Decimal 0 to 5 × ×

PV Current value monitor Decimal 1 to 143 × ×
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■6 Availability of writing/reading data to/from double-word devices ([FREQROL 800/
E700NE(Batch monitor)])

The following shows the availability of writing/reading data to/from double-word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Only reading is available for OP3.
Only writing is available for OP4 and OP5.

■7 Virtual inverter devices ([FREQROL 800/E700NE(Batch monitor)])
The following shows the correspondence between the virtual devices used in the GOT and the inverter data.
For details on the inverter parameters, refer to the following.

➟Manual of the inverter used

*1 The virtual device is also usable for the controller whose type is [FREQROL 500/700/800, SENSORLESS SERVO] or 
[FREQROL 800].
Use the device to maintain compatibility when you change the controller type in a project from any of the above ones to 
[FREQROL 800(Batch monitor)].

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

AL -/- R/- -/- -/-

LPr -/- R/W -/- -/-

OP*1 -/- R/W -/- -/-

PV -/- R/- -/- -/-

Virtual device name Reference

RS*1 ➟(1) Inverter status monitor ([FREQROL 800/E700NE(Batch monitor)])

WS*1
➟(2) Operation command ([FREQROL 800/E700NE(Batch monitor)])

➟(3) Operation when turning on/off the WS devices ([FREQROL 800/E700NE(Batch monitor)])

IOST ➟(4) I/O terminal monitor ([FREQROL 800/E700NE(Batch monitor)])

CMD

➟(5) Operation command ([FREQROL 800/E700NE(Batch monitor)])

➟(6) Operation when turning on/off one of the CMD3 to CMD12 devices ([FREQROL 800/E700NE(Batch monitor)])

➟(7) Operation when turning on/off one of the CMD48 to CMD52 devices ([FREQROL 800/E700NE(Batch monitor)])

A*1 ➟(8) Alarm definition ([FREQROL 800/E700NE(Batch monitor)])

Pr*1 ➟(9) Parameter, parameter (32-bit) ([FREQROL 800/E700NE(Batch monitor)])

SP*1
➟(10) Special parameter ([FREQROL 800/E700NE(Batch monitor)])

➟(11) Specifications of SP122 and SP121 ([FREQROL 800/E700NE(Batch monitor)])

AL ➟(12) Alarm history ([FREQROL 800/E700NE(Batch monitor)])

LPr ➟(9) Parameter, parameter (32-bit) ([FREQROL 800/E700NE(Batch monitor)])

OP ➟(13) Operation parameter ([FREQROL 800/E700NE(Batch monitor)])

PV ➟(14) Current value monitor ([FREQROL 800/E700NE(Batch monitor)])
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When you create a project, use a different device.
The lists of virtual devices shown in this section explain the FR-A800 Plus series and FR-E800 series models using the 
following abbreviations.

(1) Inverter status monitor ([FREQROL 800/E700NE(Batch monitor)])
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

➟Manual of the inverter used
○: Available
×: Not available

*1 The monitor data can be changed by the settings of Pr.190 to Pr.196 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

(2) Operation command ([FREQROL 800/E700NE(Batch monitor)])
Parameter settings may have been changed in the inverter.
To use the devices, check the parameters and set the parameters as required.

➟Manual of the inverter used
○: Available
×: Not available

Series Abbreviation Model

FR-A800 Plus series

CRN

FR-A8□0-CRN
FR-A8□2-CRN
FR-A8□0-E-CRN
FR-A8□2-E-CRN

R2R

FR-A8□0-R2R
FR-A8□2-R2R
FR-A8□0-E-R2R
FR-A8□2-E-R2R

AWH
FR-A8□0-AWH
FR-A8□0-E-AWH

LC
FR-A8□0-LC
FR-A8□0-E-LC

FR-E800 series
E800 FR-E8□0

E FR-E8□0-E

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

RS0 RUN (Inverter running) ○*1 ○*1 ○*1

RS1 During forward rotation ○ ○ ○

RS2 During reverse rotation ○ ○ ○

RS3 SU (Up to frequency) ○*1 ○ ○

RS4 OL (Overload warning) ○*1 ○ ○

RS5 IPF (Instantaneous power failure/
undervoltage) ○*1 × ×

RS6 FU (Output frequency detection) ○*1 ○*1 ○*1

RS7 ABC1 (Fault) ○*1 ○*1 ○*1

RS8 ABC2 ○*1 × ×

RS9 Safety monitor output ○ ○ ×

RS15 Fault occurrence ○ ○ ○

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

WS0*1 AU (Terminal 4 input selection) ○*2 ○ ○

WS1 Forward rotation command ○ ○ ○

WS2 Reverse rotation command ○ ○ ○
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*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the relevant setting in Pr.180 to Pr.189 (input terminal function selection).

When using the operation command, note the following.

(3) Operation when turning on/off the WS devices ([FREQROL 800/E700NE(Batch monitor)])
When you turn on/off one of the WS0 to WS15 devices, the rest of these devices are turned off.
Example) When you turn on WS9
WS0 to WS8 and WS10 to WS15 are turned off.
The following shows the relationship between the inverter's operation commands and WS devices.

The function of each bit differs depending on the inverter.
Example) A800 series inverter

• WS0: AU (Terminal 4 input selection)
• WS1: Forward rotation command
• WS2: Reverse rotation command
• WS3: RL (Low-speed operation command)
• WS4: RM (Middle-speed operation command)

WS3*1 RL (Low-speed operation 
command) ○*2 ○*2 ○*2

WS4*1 RM (Middle-speed operation 
command) ○*2 ○*2 ○*2

WS5*1 RH (High-speed operation 
command) ○*2 ○*2 ○*2

WS6*1 RT (Second function selection) ○*2 ○ ○

WS7*1 MRS (Output stop) ○*2 ○*2 ○*2

WS8*1 JOG (Jog operation selection) ○ *2*3 ○ ×

WS9*1
CS (Selection of automatic restart 
after instantaneous power failure, 
flying start)

○ *2*3 × ×

WS10*1 STOP (Start self-holding 
selection) ○ *2*3 × ×

WS11*1 RES (Inverter reset) ○ *2*3 ○ *2*3 ○*2

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

When activating WS devices ➟(3) Operation when turning on/off the WS devices ([FREQROL 800/E700NE(Batch 
monitor)])

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

Operation command
b15 b7 b0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
WS0
WS1
WS2
WS3
WS4
WS5
WS6
WS7
WS8
WS9
WS10
WS11
Not used
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• WS5: RH (High-speed operation command)
• WS6: RT (Second function selection)
• WS7: MRS (Output stop)
• WS8: JOG (Jog operation selection)
• WS9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• WS10: STOP (Start self-holding selection)
• WS11: RES (Inverter reset)

Use SP122 or SP121 to control multiple WS devices simultaneously.
➟(11) Specifications of SP122 and SP121 ([FREQROL 800/E700NE(Batch monitor)])

(4) I/O terminal monitor ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series FR-E700 series

E800 E FR-E7□0-NE

IOST1 Input terminal STF/DI0 ○*1 ○*1 ○*1 ○*1

IOST2 Input terminal STR/DI1 ○*1 ○*1 ○*1 ○*1

IOST3 Input terminal RL ○*1 ○*1 × ○*1

IOST4 Input terminal RM ○*1 ○*1 × ○*1

IOST5 Input terminal RH ○*1 ○*1 × ○*1

IOST6 Input terminal RT ○*1 × × ×

IOST7 Input terminal AU ○*1 × × ×

IOST8 Input terminal JOG ○*1 × × ×

IOST9 Input terminal CS ○*1 × × ×

IOST10 Input terminal MRS ○*1 ○*1 × ○*1

IOST11 Input terminal STOP ○*1 × × ×

IOST12 Input terminal RES ○*1 ○*1 × ○*1

IOST32 Output terminal RUN ○*1 ○*1 × ○*1

IOST33 Output terminal SU ○*1 × × ×

IOST34 Output terminal IPF ○*1 × × ×

IOST35 Output terminal OL ○*1 × × ×

IOST36 Output terminal FU ○*1 ○*1 × ○*1

IOST37 Output terminal ABC1 ○*1 ○*1 ○*1 ○*1

IOST38 Output terminal ABC2 ○*1 × × ×

IOST39 Output terminal SO ○ × × ×

IOST48 NET Y1 output × ○ *1*2 ○ *1*2 ×

IOST49 NET Y2 output × ○ *1*2 ○ *1*2 ×

IOST50 NET Y3 output × ○ *1*2 ○ *1*2 ×

IOST51 NET Y4 output × ○ *1*2 ○ *1*2 ×

IOST64 Option input terminal X0 ○ ○ ○ ×

IOST65 Option input terminal X1 ○ ○ ○ ×

IOST66 Option input terminal X2 ○ ○ ○ ×

IOST67 Option input terminal X3 ○ ○ ○ ×

IOST68 Option input terminal X4 ○ ○ ○ ×

IOST69 Option input terminal X5 ○ ○ ○ ×

IOST70 Option input terminal X6 ○ ○ ○ ×

IOST71 Option input terminal X7 ○ ○ ○ ×
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*1 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection) or Pr.190 to Pr.196 
or Pr.313 to Pr.322 (output terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*2 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

(5) Operation command ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

IOST72 Option input terminal X8 ○ ○ ○ ×

IOST73 Option input terminal X9 ○ ○ ○ ×

IOST74 Option input terminal X10 ○ ○ ○ ×

IOST75 Option input terminal X11 ○ ○ ○ ×

IOST76 Option input terminal X12 ○ ○ ○ ×

IOST77 Option input terminal X13 ○ ○ ○ ×

IOST78 Option input terminal X14 ○ ○ ○ ×

IOST79 Option input terminal X15 ○ ○ ○ ×

IOST80 Option input terminal DY ○ ○ ○ ×

IOST96 Option output terminal Y0/DO0 ○*1 ○*1 ○*1 ×

IOST97 Option output terminal Y1/DO1 ○*1 ○*1 ○*1 ×

IOST98 Option output terminal Y2/DO2 ○*1 ○*1 ○*1 ×

IOST99 Option output terminal Y3/DO3 ○*1 ○*1 ○*1 ×

IOST100 Option output terminal Y4/DO4 ○*1 ○*1 ○*1 ×

IOST101 Option output terminal Y5/DO5 ○*1 ○*1 ○*1 ×

IOST102 Option output terminal Y6/DO6 ○*1 ○*1 ○*1 ×

IOST103 Option output terminal RA1 ○*1 ○*1 ○*1 ×

IOST104 Option output terminal RA2 ○*1 ○*1 ○*1 ×

IOST105 Option output terminal RA3 ○*1 ○*1 ○*1 ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series FR-E700 series

E800 E FR-E7□0-NE

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

CMD0 Stop command ○ ○ ○

CMD1 Forward rotation command ○ ○ ○

CMD2 Reverse rotation command ○ ○ ○

CMD3*1 RL terminal ○*2 ○*2 ○*2

CMD4*1 RM terminal ○*2 ○*2 ○*2

CMD5*1 RH terminal ○*2 ○*2 ○*2

CMD6*1 RT terminal ○*2 ○ ○

CMD7*1 AU terminal ○*2 ○ ○

CMD8*1 JOG terminal ○ *2*3 ○ ×

CMD9*1 CS terminal ○ *2*3 × ×

CMD10*1 MRS terminal ○*2 ○*2 ○*2

CMD11*1 STOP terminal ○ *2*3 × ×

CMD12*1 RES terminal ○ *2*3 ○ *2*3 ○*2

CMD16 Alarm history clear ○ ○ ○

CMD24 Inverter reset ○ ○ ○
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*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the relevant setting in Pr.180 to Pr.189 (input terminal function selection).

*4 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

When using the operation command, note the following.

(6) Operation when turning on/off one of the CMD3 to CMD12 devices ([FREQROL 800/E700NE(Batch 
monitor)])
The CMD3 to CMD12 devices cannot be controlled simultaneously.
When you turn on/off one of the CMD3 to CMD12 devices, the rest of these devices are turned off.
Use OP4 to control multiple devices from CMD3 to CMD12 simultaneously.
The following shows the relationship between CMD3 to CMD12 and OP4.

Example) Turning on the CMD3 (RL terminal) and CMD12 (RES terminal) devices
For a hexadecimal value, write 0201.
For a decimal value, write 513.

CMD32 Parameter clear ○ ○ ○

CMD33 Parameter clear (communication 
parameters are not cleared) ○ ○ ○

CMD34 All parameter clear ○ ○ ○

CMD35
All parameter clear 
(communication parameters are 
not cleared)

○ ○ ○

CMD48 NET X1 input × ○*2*3*4 ×

CMD49 NET X2 input × ○*2*3*4 ×

CMD50 NET X3 input × ○*2*3*4 ×

CMD51 NET X4 input × ○*2*3*4 ×

CMD52 NET X5 input × ○*2*3*4 ×

Precautions Description

When setting a device for a bit switch Do not select [Alternate] for [Switch Action] of the bit switch.

Operation when a CMD device is turned on
➟(6) Operation when turning on/off one of the CMD3 to CMD12 devices ([FREQROL 800/

E700NE(Batch monitor)])
(7) Operation when turning on/off one of the CMD48 to CMD52 devices ([FREQROL 800/

E700NE(Batch monitor)])

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

OP4
b15 b7 b0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

CMD3
CMD4
CMD5
CMD6
CMD7
CMD8
CMD9
CMD10
CMD11
CMD12

b31 b23
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
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(7) Operation when turning on/off one of the CMD48 to CMD52 devices ([FREQROL 800/E700NE(Batch 
monitor)])
The CMD48 to CMD52 devices cannot be controlled simultaneously.
When you turn on/off one of the CMD48 to CMD52 devices, the rest of these devices are turned off.
Use OP5 to control multiple devices from CMD48 to CMD52 simultaneously.
The following shows the relationship between CMD48 to CMD52 and OP5.

Example) Turning on the CMD48 (NET X1 input) and CMD52 (NET X5 input) devices
For a hexadecimal value, write 0011.
For a decimal value, write 17.

(8) Alarm definition ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

(9) Parameter, parameter (32-bit) ([FREQROL 800/E700NE(Batch monitor)])
The virtual device numbers (Pr and LPr) used in the GOT correspond to the inverter parameter numbers.
For the inverter parameters, refer to the following.

➟Manual of the inverter used
When using a parameter, note the following.

OP5
b15 b7 b0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

CMD48
CMD49
CMD50
CMD51
CMD52

b31 b23
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

A0 Second alarm in past ○ ○ ○

A1 Latest fault ○ ○ ○

A2 Fourth fault in past ○ ○ ○

A3 Third fault in past ○ ○ ○

A4 Sixth fault in past ○ ○ ○

A5 Fifth fault in past ○ ○ ○

A6 Eighth fault in past ○ ○ ○

A7 Seventh fault in past ○ ○ ○

Precautions Description

When setting 8888 or 9999 to a parameter (Pr) 
of an inverter

Values 8888 and 9999 are used for particular purposes.
To set these values to inverter parameters using the virtual devices, write the following values 
from the GOT.
• To set 8888: 65520
• To set 9999: 65535

When setting 8888 or 9999 to a 32-bit parameter 
(Lpr) of an inverter

Values 8888 and 9999 are used for particular purposes.
To set these values to inverter parameters, write the following values to the GOT virtual device.
• To set 8888: 8888
• To set 9999: 9999
You are recommended to set the data type to [Real] for a parameter that can accept a value 
with a fractional part.

When specifying a calibration parameter or PID 
display

If you specify Pr900 to Pr933 (Calibration parameter), or Pr934 and Pr935 (PID display), 
whether the value below must be written to SP108 (Second parameter changing) depends on 
the specified device number and inverter model.
• H00: Offset/gain
• H01: Analog
• H02: Analog value at terminal
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(10)Special parameter ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, SP121.b1, 
SP121.b2, SP122.b1, and SP122.b2 can be used.
For the specifications of SP122 and SP121, refer to the following.
➟(11) Specifications of SP122 and SP121 ([FREQROL 800/E700NE(Batch monitor)])

(11)Specifications of SP122 and SP121 ([FREQROL 800/E700NE(Batch monitor)])
SP122 and SP121 are the GOT's virtual devices corresponding to the inverter's operation commands.
The following shows the specifications of SP122 and SP121.

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

SP108 Second parameter changing ○ ○ ○

SP109 Set frequency (RAM) ○ ○ ○

SP110 Set frequency (RAM, EEPROM) ○ ○ ○

SP111 Output frequency/speed ○ ○ ○

SP112 Output current ○ ○ ○

SP113 Output voltage ○ ○ ○

SP114 Special monitor ○ ○ ○

SP115 Special monitor selection No. ○ ○ ○

SP116 Latest fault, Second fault in past/
Faults history batch clear ○ ○ ○

SP117 Third fault in past, fourth fault in 
past ○ ○ ○

SP118 Fifth fault in past, sixth fault in past ○ ○ ○

SP119 Seventh fault in past, Eighth fault 
in past ○ ○ ○

SP121*1 Inverter status monitor (extended) 
/ Operation command (extended) ○ ○ ○

SP122*1 Inverter status monitor / Operation 
command ○ ○ ○

SP123 Operation mode ○ ○ ○

SP124 All parameter clear ○ ○ ○

SP125 Inverter reset ○ ○ ○

SP127 Link parameter extended setting ○ ○ ○

SP device Specifications

SP122

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP122.b0: AU (Terminal 4 input selection)
• SP122.b1: Forward rotation command
• SP122.b2: Reverse rotation command
• SP122.b3: RL (Low-speed operation command)
• SP122.b4: RM (Middle-speed operation command)
• SP122.b5: RH (High-speed operation command)
• SP122.b6: RT (Second function selection)
• SP122.b7: MRS (Output stop)
• SP122.b8 to b15: Fixed to 0

SP122 (virtual device) is used to maintain compatibility when you change the controller type from [FREQROL 500/700/800, 
SENSORLESS SERVO] or [FREQROL 800] to [FREQROL 800/E700NE(Batch monitor)].
When [FREQROL 800/E700NE(Batch monitor)] is set, writing a value to SP122 clears each bit of SP122.b8 to SP122.b15.

To send more than one command simultaneously, convert the binary value of the bits to be turned on to a decimal value, 
and write the decimal value to SP122.
Example) Sending forward rotation command and RL (Low-speed operation command) simultaneously
Binary: 0000000000001010
Decimal: 10
Write 10 to SP122.
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(12)Alarm history ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

SP121

The function of each bit differs depending on the inverter.
Example) A800 series inverter
• SP121.b0: AU (Terminal 4 input selection)
• SP121.b1: Forward rotation command
• SP121.b2: Reverse rotation command
• SP121.b3: RL (Low-speed operation command)
• SP121.b4: RM (Middle-speed operation command)
• SP121.b5: RH (High-speed operation command)
• SP121.b6: RT (Second function selection)
• SP121.b7: MRS (Output stop)
• SP121.b8: JOG (Jog operation selection)
• SP121.b9: CS (Selection of automatic restart after instantaneous power failure, flying start)
• SP121.b10: STOP (Start self-holding selection)
• SP121.b11: RES (Inverter reset)

To send more than one command simultaneously, convert the binary value of the device (with applicable bits on) to a 
decimal value, and write the decimal value to SP121.
Example) Sending forward rotation command, RL (Low-speed operation command), and JOG (Jog operation selection) 
simultaneously
Binary: 0000000100001010
Decimal: 266
Write 266 to SP121.

SP device Specifications

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

AL0 Current fault ○ ○ ○

AL1 Current warning 1 × ○ ×

AL2 Current warning 2 × ○ ×

AL100 Faults history 1 (symbol) ○ ○ ○

AL101 Faults history 1 (output frequency) ○ ○ ○

AL102 Faults history 1 (output current) ○ ○ ○

AL103 Faults history 1 (output voltage) ○ ○ ○

AL104 Faults history 1 (energization time) ○ ○ ○

AL105 Faults history 1 (year) ○ ○ ×

AL106 Faults history 1 (month) ○ ○ ×

AL107 Faults history 1 (day) ○ ○ ×

AL108 Faults history 1 (hour) ○ ○ ×

AL109 Faults history 1 (minute) ○ ○ ×

AL200 Faults history 2 (symbol) ○ ○ ○

AL201 Faults history 2 (output frequency) ○ ○ ○

AL202 Faults history 2 (output current) ○ ○ ○

AL203 Faults history 2 (output voltage) ○ ○ ○

AL204 Faults history 2 (energization time) ○ ○ ○

AL205 Faults history 2 (year) ○ ○ ×

AL206 Faults history 2 (month) ○ ○ ×

AL207 Faults history 2 (day) ○ ○ ×

AL208 Faults history 2 (hour) ○ ○ ×

AL209 Faults history 2 (minute) ○ ○ ×

AL300 Faults history 3 (symbol) ○ ○ ○

AL301 Faults history 3 (output frequency) ○ ○ ○

AL302 Faults history 3 (output current) ○ ○ ○

AL303 Faults history 3 (output voltage) ○ ○ ○
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AL304 Faults history 3 (energization time) ○ ○ ○

AL305 Faults history 3 (year) ○ ○ ×

AL306 Faults history 3 (month) ○ ○ ×

AL307 Faults history 3 (day) ○ ○ ×

AL308 Faults history 3 (hour) ○ ○ ×

AL309 Faults history 3 (minute) ○ ○ ×

AL400 Faults history 4 (symbol) ○ ○ ○

AL401 Faults history 4 (output frequency) ○ ○ ○

AL402 Faults history 4 (output current) ○ ○ ○

AL403 Faults history 4 (output voltage) ○ ○ ○

AL404 Faults history 4 (energization time) ○ ○ ○

AL405 Faults history 4 (year) ○ ○ ×

AL406 Faults history 4 (month) ○ ○ ×

AL407 Faults history 4 (day) ○ ○ ×

AL408 Faults history 4 (hour) ○ ○ ×

AL409 Faults history 4 (minute) ○ ○ ×

AL500 Faults history 5 (symbol) ○ ○ ○

AL501 Faults history 5 (output frequency) ○ ○ ○

AL502 Faults history 5 (output current) ○ ○ ○

AL503 Faults history 5 (output voltage) ○ ○ ○

AL504 Faults history 5 (energization time) ○ ○ ○

AL505 Faults history 5 (year) ○ ○ ×

AL506 Faults history 5 (month) ○ ○ ×

AL507 Faults history 5 (day) ○ ○ ×

AL508 Faults history 5 (hour) ○ ○ ×

AL509 Faults history 5 (minute) ○ ○ ×

AL600 Faults history 6 (symbol) ○ ○ ○

AL601 Faults history 6 (output frequency) ○ ○ ○

AL602 Faults history 6 (output current) ○ ○ ○

AL603 Faults history 6 (output voltage) ○ ○ ○

AL604 Faults history 6 (energization time) ○ ○ ○

AL605 Faults history 6 (year) ○ ○ ×

AL606 Faults history 6 (month) ○ ○ ×

AL607 Faults history 6 (day) ○ ○ ×

AL608 Faults history 6 (hour) ○ ○ ×

AL609 Faults history 6 (minute) ○ ○ ×

AL700 Faults history 7 (symbol) ○ ○ ○

AL701 Faults history 7 (output frequency) ○ ○ ○

AL702 Faults history 7 (output current) ○ ○ ○

AL703 Faults history 7 (output voltage) ○ ○ ○

AL704 Faults history 7 (energization time) ○ ○ ○

AL705 Faults history 7 (year) ○ ○ ×

AL706 Faults history 7 (month) ○ ○ ×

AL707 Faults history 7 (day) ○ ○ ×

AL708 Faults history 7 (hour) ○ ○ ×

AL709 Faults history 7 (minute) ○ ○ ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE
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(13)Operation parameter ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

*1 When the GOT is connected to the PU connector and the operation mode is set to the PU operation mode, the device cannot 
be used.

*2 The monitor data can be changed by the settings of Pr.180 to Pr.189 (input terminal function selection).
For the relationship between the parameters and terminals, refer to the following.
➟Manual of the inverter used

*3 The device is invalid for the initial state of the inverter in which a function that cannot be controlled by the GOT is set or no 
function is set.
Change the relevant setting in Pr.180 to Pr.189 (input terminal function selection).

*4 Use an inverter having SERIAL (serial No.) "□□211○○○○○○" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

AL800 Faults history 8 (symbol) ○ ○ ○

AL801 Faults history 8 (output frequency) ○ ○ ○

AL802 Faults history 8 (output current) ○ ○ ○

AL803 Faults history 8 (output voltage) ○ ○ ○

AL804 Faults history 8 (energization time) ○ ○ ○

AL805 Faults history 8 (year) ○ ○ ×

AL806 Faults history 8 (month) ○ ○ ×

AL807 Faults history 8 (day) ○ ○ ×

AL808 Faults history 8 (hour) ○ ○ ×

AL809 Faults history 8 (minute) ○ ○ ×

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

Virtual device name Name
FR-A800 series 

FR-A800 Plus series 
FR-F800 series

FR-E800 series
FR-E700 series

FR-E7□0-NE

OP0 Operation frequency(RAM) ○ ○ ○

OP1 Operation frequency (EEPROM) ○ ○ ○

OP2 Operation mode ○ ○ ○

OP3 Operating status ○ ○ ○

OP4*1*2*

3

- Input terminal command

○ ○ ○

b0 CMD3: RL terminal

b1 CMD4: RM terminal

b2 CMD5: RH terminal

b3 CMD6: RT terminal

b4 CMD7: AU terminal

b5 CMD8: JOG terminal

b6 CMD9: CS terminal

b7 CMD10: MRS terminal

b8 CMD11: STOP terminal

b9 CMD12: RES terminal

OP5*2

- Input terminal command (Extend)

× ○*4 ×

b0 CMD48: NET X1 input

b1 CMD49: NET X2 input

b2 CMD50: NET X3 input

b3 CMD51: NET X4 input

b4 CMD52: NET X5 input
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(14)Current value monitor ([FREQROL 800/E700NE(Batch monitor)])
○: Available
×: Not available

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE

PV1
Output frequency/speed × × × ○ × × × × ○

Output frequency ○ ○ ○ × ○ ○ ○ ○ ×

PV2 Output current ○ ○ ○ ○ ○ ○ ○ ○ ○

PV3 Output voltage ○ ○ ○ ○ ○ ○ ○ ○ ○

PV5

Frequency setting value/
speed setting × × × ○ × × × × ○

Frequency setting value ○ ○ ○ × ○ ○ ○ ○ ×

PV6
Speed/machine speed ○ ○ ○ ○ × ○ ○ ○ ×

Operation speed × × × × ○ × × × ×

PV7 Motor torque ○ ○ ○ ○ ○ ○ ○ ○ ○

PV8 Converter output voltage ○ ○ ○ ○ ○ ○ ○ ○ ○

PV9 Regenerative brake duty ○ ○ ○ ○ ○ × ○ ○ ○

PV10 Electronic thermal O/L relay 
load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV11 Output current peak value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV12 Converter output voltage 
peak value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV13 Input power ○ ○ ○ ○ ○ ○ × × ×

PV14 Output power ○ ○ ○ ○ ○ ○ ○ ○ ○

PV17 Load meter ○ ○ ○ ○ ○ ○ ○ ○ ×

PV18 Motor excitation current ○ ○ ○ ○ ○ ○ ○ ○ ×

PV19

Position pulse ○ ○ × × ○ × × × ×

Analog output signal for 
dancer tension control × × ○ ○ × × × × ×

PV20 Cumulative energization 
time ○ ○ ○ ○ ○ ○ ○ ○ ○

PV22
Orientation status ○ ○ × × ○ × × × ×

Winding diameter × × ○ ○ × × × × ×

PV23 Actual operation time ○ ○ ○ ○ ○ ○ ○ ○ ○

PV24 Motor load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV25 Cumulative power ○ ○ ○ ○ ○ ○ ○ ○ ○

PV26

Position command (lower 
digits) × ○ × × × × × × ×

Line speed command × × ○ ○ × × × × ×

PV27

Position command (upper 
digits) × ○ × × × × × × ×

Actual line speed × × ○ ○ × × × × ×

PV28

Current position (lower 
digits) × ○ × × × × × × ×

Dancer compensation 
speed × × ○ ○ × × × × ×

PV29

Current position (upper 
digits) × ○ × × × × × × ×

Winding length (upper + 
lower) × × ○ ○ × × × × ×

PV30

Droop pulse (lower digits) × ○ × × × × × × ×

Analog output signal 2 for 
dancer tension control × × ○ ○ × × × × ×
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PV31
Droop pulse (upper digits) × ○ × × × × × × ×

Line speed pulse monitor × × ○ ○ × × × × ×

PV32 Torque command ○ ○ ○ ○ ○ × ○ ○ ×

PV33 Torque current command ○ ○ ○ ○ ○ × ○ ○ ×

PV34 Motor output ○ ○ ○ ○ ○ ○ × × ×

PV35 Feedback pulse ○ ○ ○ ○ ○ × × × ×

PV36

Torque (positive polarity for 
driving torque/negative 
polarity for regenerative 
braking torque)

○ ○ ○ ○ ○ × × × ×

PV38 Trace status × ○ ○ ○ × × × × ×

PV39 SSCNET III communication 
status ○ ○ × × ○ × × × ×

PV40 PLC function user monitor 1 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV41 PLC function user monitor 2 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV42 PLC function user monitor 3 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV43 Station number (RS-485 
terminals) × ○ ○ ○ × × × × ×

PV44 Station number (PU) × ○ ○ ○ × × × × ×

PV45 Station number (CC-Link) × ○ ○ ○ × × × × ×

PV46 Motor temperature ○ ○ ○ ○ ○ × × × ×

PV50 Energy saving effect ○ ○ ○ ○ ○ ○ ○ ○ ×

PV51 Cumulative energy saving ○ ○ ○ ○ ○ ○ ○ ○ ×

PV52 PID set point ○ ○ ○ ○ ○ ○ ○ ○ ○

PV53 PID measured value ○ ○ ○ ○ ○ ○ ○ ○ ○

PV54 PID deviation ○ ○ ○ ○ ○ ○ ○ ○ ○

PV61 Motor thermal load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV62 Inverter thermal load factor ○ ○ ○ ○ ○ ○ ○ ○ ○

PV63
Cumulative power 2 × × × × × × × × ○

Winding length (upper) × × ○ ○ × × × × ×

PV64 PTC thermistor resistance ○ ○ ○ ○ ○ ○ × × ×

PV67 PID measured value 2 ○ ○ ○ ○ ○ ○ ○ ○ ×

PV68 Emergency drive status × × × × × × × × ×

PV69 PID input pressure value × × × × × ○ × × ×

PV71 Cumulative pulse ○ ○ ○ ○ ○ × × × ×

PV72 Cumulative pulse overflow 
times ○ ○ ○ ○ ○ × × × ×

PV73 Cumulative pulse (control 
terminal option) ○ ○ ○ ○ ○ × × × ×

PV74
Cumulative pulse overflow 
times (control terminal 
option)

○ ○ ○ ○ ○ × × × ×

PV75 Multi-revolution counter ○ ○ × × ○ × × × ×

PV77 32-bit cumulative energy 
(lower 16 bits) × × × ○ × × × × ×

PV78 32-bit cumulative energy 
(upper 16 bits) × × × ○ × × × × ×

PV79 32-bit cumulative energy 
(lower 16 bits) × × × ○ × × × × ×

PV80 32-bit cumulative energy 
(upper 16 bits) × × × ○ × × × × ×

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE
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PV81

BACnet reception status × × × × × ○ × × ×

Tension command after 
taper compensation × × ○ ○ × × × × ×

PV82

BACnet token pass counter × × × × × ○ × × ×

Winding diameter 
compensation torque 
command

× × ○ ○ × × × × ×

PV83

BACnet valid APDU 
counter × × × × × ○ × × ×

Inertia compensation × × ○ ○ × × × × ×

PV84

BACnet communication 
error counter × × × × × ○ × × ×

Mechanical loss 
compensation × × ○ ○ × × × × ×

PV85

BACnet terminal FM/CA 
output level × × × × × ○ × × ×

Terminal 1 input voltage × × ○ ○ × × × × ×

PV86

BACnet terminal AM output 
level × × × × × ○ × × ×

Terminal 1 input after 
calibration (%) × × ○ ○ × × × × ×

PV87 Remote output value 1 ○ ○ ○ ○ ○ ○ × × ×

PV88 Remote output value 2 ○ ○ ○ ○ ○ ○ × × ×

PV89 Remote output value 3 ○ ○ ○ ○ ○ ○ × × ×

PV90 Remote output value 4 ○ ○ ○ ○ ○ ○ × × ×

PV91 PID manipulated variable ○ ○ ○ ○ ○ ○ ○ ○ ×

PV92

Second PID set point ○ ○ × × ○ ○ × × ×

PID torque control actual 
tension × × ○ × × × × × ×

PV93

Second PID measured 
value ○ ○ × × ○ ○ × × ×

PID torque control 
manipulated tension × × ○ × × × × × ×

PV94 Second PID deviation ○ ○ × × ○ ○ × × ×

PV95 Second PID measured 
value 2 ○ ○ × × ○ ○ × × ×

PV96 Second PID manipulated 
variable ○ ○ × × ○ ○ × × ×

PV97

Dancer main set speed
(For FR-E800 and FR-
E800-E, dancer main speed 
setting)

○ ○ × × ○ × ○ ○ ×

Winding diameter 
compensation speed × × ○ ○ × × × × ×

PV98 Control circuit temperature ○ ○ ○ ○ ○ ○ × × ×

Virtual 
device name Name FR-A800 

series
FR-A800 Plus series FR-F800 

series
FR-E800 series FR-E700 series

CRN R2R AWH LC E800 E FR-E7□0-NE
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12.3.26 [Laser Displacement Sensor MH11]

Only available to GT2104-PMBDS2.

■1 Monitoring-supported bit devices ([Laser Displacement Sensor MH11])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.26 ■2 Availability of writing/reading data to/from bit devices ([Laser Displacement Sensor MH11])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■2 Availability of writing/reading data to/from bit devices ([Laser Displacement Sensor MH11])
The following shows the availability of writing/reading data to/from bit devices by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■3 Monitoring-supported word devices ([Laser Displacement Sensor MH11])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.3.26 ■4 Availability of writing/reading data to/from word devices ([Laser Displacement Sensor MH11])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Item Reference

Specifications of bit devices
➟■1 Monitoring-supported bit devices ([Laser Displacement Sensor MH11])

➟■2 Availability of writing/reading data to/from bit devices ([Laser Displacement Sensor MH11])

Specifications of word devices
➟■3 Monitoring-supported word devices ([Laser Displacement Sensor MH11])

➟■4 Availability of writing/reading data to/from word devices ([Laser Displacement Sensor MH11])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

R Internal relay
Decimal + 
hexadecim
al

R(Word address)(Bit address)
Notation example: R100F
• Word address (DEC): 000 to 999
• Bit address (HEX): 0 to F

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

R R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DT Data register Decimal 0 to 99999 ○ ○

WR Internal relay Decimal 000 to 999 ○ ○
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■4 Availability of writing/reading data to/from word devices ([Laser Displacement Sensor 
MH11])

The following shows the availability of writing/reading data to/from word devices by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

DT R/W R/W -/- R/W

WR R/W R/W -/- -/-
12. APPENDICES
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12.4 Device Range and Settings of Each Controller
This section describes the range of devices settable in GT Designer3 for each of non-Mitsubishi Electric products 
connected to the GOT.
The settable range varies with the selection for [Controller Type] in the [Controller Setting] window.
Configure the device setting according to the specifications of the controller to be used.
Device specifications differ depending on the controller model even among the controllers of the same series.
If a non-existent device or a device number out of the range is set for an object, other objects for which correct devices 
are set may not be monitored.

➟12.4.1 IAI equipment ([IAI X-SEL Controller])
12.4.2 IAI equipment ([IAI ROBO CYLINDER])
12.4.3 AZBIL equipment ([Azbil SDC/DMC])
12.4.4 AZBIL equipment ([Azbil DMC50])
12.4.5 OMRON equipment ([OMRON SYSMAC])
12.4.6 OMRON equipment ([OMRON NJ/NX])
12.4.7 OMRON equipment ([OMRON THERMAC/INPANEL NEO])
12.4.8 OMRON equipment ([OMRON Digital Temperature Controller])
12.4.9 KEYENCE equipment ([KEYENCE KV-700/1000/3000/5000/7000/8000])
12.4.10 KOYO EI equipment ([KOYO KOSTAC/DL])
12.4.11 JTEKT equipment ([JTEKT TOYOPUC-PC])
12.4.12 SHARP equipment ([SHARP JW])
12.4.13 SHINKO equipment ([Shinko Technos Controller])
12.4.14 CHINO equipment ([CHINO MODBUS device])
12.4.15 TOSHIBA equipment ([TOSHIBA PROSEC T/V])
12.4.16 TOSHIBA equipment ([TOSHIBA Unified Controller nv])
12.4.17 SHIBAURA MACHINE equipment ([SHIBAURA MACHINE TCmini])
12.4.18 PANASONIC equipment ([Panasonic MINAS A4])
12.4.19 PANASONIC equipment ([Panasonic MINAS A5])
12.4.20 PANASONIC IDS equipment ([Panasonic MEWNET-FP])
12.4.21 PANASONIC IDS equipment ([Panasonic FP7])
12.4.22 HITACHI IES equipment ([HITACHI IES EHV])
12.4.23 HITACHI IES equipment ([HITACHI IES HIDIC H])
12.4.24 HITACHI equipment ([HITACHI S10VE])
12.4.25 HITACHI equipment ([HITACHI S10mini/S10V])
12.4.26 HIRATA equipment ([Hirata HNC])
12.4.27 FUJI equipment ([FUJI Temperature Controller/Digital Controller])
12.4.28 FUJI equipment ([FUJI MICREX-F])
12.4.29 FUJI equipment ([FUJI MICREX-SX SPH])
12.4.30 MURATEC equipment ([Muratec MPC/MCR])
12.4.31 YASKAWA equipment ([YASKAWA GL/PROGIC8])
12.4.32 YASKAWA equipment ([YASKAWA CP9200(H)])
12.4.33 YASKAWA equipment ([YASKAWA CP9300MS(MC compatible)])
12.4.34 YASKAWA equipment ([YASKAWA MP2000/MP900/CP9200SH])
12.4.35 YASKAWA equipment ([YASKAWA MP3000])
12.4.36 YASKAWA equipment ([YASKAWA Robot Controller])
12.4.37 YOKOGAWA equipment ([YOKOGAWA STARDOM/FA500/FA-M3])
12.4.38 YOKOGAWA equipment ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])
12.4.39 RKC equipment ([RKC SR Mini HG])
12.4.40 ALLEN-BRADLEY equipment ([AB SLC500])
12.4.41 ALLEN-BRADLEY equipment ([AB MicroLogix])
12.4.42 ALLEN-BRADLEY equipment ([AB MicroLogix (Extended)])
12.4.43 ALLEN-BRADLEY equipment ([AB Control/CompactLogix])
12.4.44 ALLEN-BRADLEY equipment ([AB Control/CompactLogix(Tag)])
12.4.45 GE equipment ([GE Series 90])
12.4.46 LS IS equipment ([LS Industrial Systems XGK])
12.4.47 LS IS equipment ([LS Industrial Systems MASTER-K])
12.4.48 MITSUBISHI INDIA equipment ([MEI Nexgenie])
12.4.49 SICK equipment ([SICK Flexi Soft])
12.4.50 SIEMENS equipment ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])
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12.4.51 SIEMENS equipment ([SIEMENS S7-300/400])
12.4.52 SIEMENS equipment ([SIEMENS S7(Ethernet)])
12.4.53 SIEMENS equipment ([SIEMENS OP(Ethernet)])
12.4.54 CLPA ([CC-Link IE Field Network Basic])
12.4.55 CLPA ([SLMP])
12.4.56 MODBUS ([MODBUS Slave(GOT:Master)])
12.4.57 MODBUS ([MODBUS Master(GOT:Slave)])
12.4.58 ODVA ([DeviceNet])
12.4.59 OPC ([OPC UA])
12.4.60 PROFIBUS ([PROFIBUS DP])
12.4.61 Microcomputer ([Computer])

12.4.1 IAI equipment ([IAI X-SEL Controller])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([IAI X-SEL Controller])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([IAI X-SEL Controller])

➟■3 Availability of writing/reading data to/from bit devices ([IAI X-SEL Controller])

Specifications of word devices

➟■4 Monitoring-supported word devices ([IAI X-SEL Controller])

➟■5 Axis Status device details ([IAI X-SEL Controller])

➟■6 Scara Axis Status device details ([IAI X-SEL Controller])

➟■7 Version device details ([IAI X-SEL Controller])

➟■8 Program Status device details ([IAI X-SEL Controller])

➟■9 System Status device details ([IAI X-SEL Controller])

➟■10 Servo device details ([IAI X-SEL Controller])

➟■11 Write to Flash ROM device details ([IAI X-SEL Controller])

➟■12 Return to Origin device details ([IAI X-SEL Controller])

➟■13 Point Number Movement device details ([IAI X-SEL Controller])

➟■14 Operation Stop/Cancel device details ([IAI X-SEL Controller])

➟■15 Availability of writing/reading data to/from word devices ([IAI X-SEL Controller])

Specifications of double-word 
devices

➟■16 Monitoring-supported double-word devices ([IAI X-SEL Controller])

➟■17 Coordinate Affiliate Data device details ([IAI X-SEL Controller])

➟■18 Error Detail device details ([IAI X-SEL Controller])

➟■19 Point Data device details ([IAI X-SEL Controller])

➟■20 Simple Interference Check Zone Data device details ([IAI X-SEL Controller])

➟■21 Jogging/Inching Movement device details ([IAI X-SEL Controller])

➟■22 Availability of writing/reading data to/from double-word devices ([IAI X-SEL Controller])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■1 Device setting dialog ([IAI X-SEL Controller])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of IP000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Switch to the device define dialog] button
You can open the device definition setting dialog to check the definition of the device.

➟6.1.6 ■6 Device definition setting dialog

■2 Monitoring-supported bit devices ([IAI X-SEL Controller])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.1 ■3 Availability of writing/reading data to/from bit devices ([IAI X-SEL Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

2) 3)

4)

1)

IP000

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IP Input Port Decimal 000 to 299 ○ ×

OP Output Port Decimal 300 to 599 ○ ×

FG Flag Decimal

FG(Program No.):(Flag No.)
Notation example: FG000:899

○ ×Global area
• Program No. (decimal): 000
• Flag No. (decimal): 600 to 899

Local area
• Program No. (decimal): 001 to 128
• Flag No. (decimal): 900 to 999

PCLR Point Data Clear Hexadeci
mal 0001 to 4E20 ○ ×
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■3 Availability of writing/reading data to/from bit devices ([IAI X-SEL Controller])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 When a word device is specified, only 1 can be set for the rightmost digit of the device number.

■4 Monitoring-supported word devices ([IAI X-SEL Controller])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.1 ■15 Availability of writing/reading data to/from word devices ([IAI X-SEL Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IP R/- -/- R/- -/- -/-

OP R/W -/- R/W -/- -/-

FG R/W -/- R/W -/- -/-

PCLR*1 -/W -/- -/W -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PDT Point Data Total Count Decimal 0 × ×

STR String Decimal

STR(Program No.):(Variable No.)
Notation example: STR000:998

○ ×Global area
• Program No. (decimal): 000
• Variable No. (decimal): 300 to 998 

(even numbers only)

Local area
• Program No. (decimal): 001 to 128
• Variable No. (decimal): 001 to 299 

(odd numbers only)

AXST Axis Status Hexadeci
mal

➟12.4.1 ■5 Axis Status device details ([IAI X-SEL 
Controller])

○ ×

SAXS0
Scara Axis Status 0 
(Base coordinate 
system)

Hexadeci
mal

➟12.4.1 ■6 Scara Axis Status device details ([IAI X-
SEL Controller])

○ ×

SAXS1
Scara Axis Status 1 
(Selected work 
coordinate system)

Hexadeci
mal

➟12.4.1 ■6 Scara Axis Status device details ([IAI X-
SEL Controller])

○ ×

SAXS2
Scara Axis Status 2 
(Reserved for system 
use)

Hexadeci
mal

➟12.4.1 ■6 Scara Axis Status device details ([IAI X-
SEL Controller])

○ ×

SAXS3 Scara Axis Status 3 
(Each axis system)

Hexadeci
mal

➟12.4.1 ■6 Scara Axis Status device details ([IAI X-
SEL Controller])

○ ×

VR0 Version 0 (Main CPU 
application)

Hexadeci
mal

➟12.4.1 ■7 Version device details ([IAI X-SEL 
Controller])

○ ×

VR1 Version 1 (Main CPU 
core)

Hexadeci
mal

➟12.4.1 ■7 Version device details ([IAI X-SEL 
Controller])

○ ×

VR2 Version 2 (Driver CPU) Hexadeci
mal

➟12.4.1 ■7 Version device details ([IAI X-SEL 
Controller])

○ ×

VR3 Version 3 (Mount SIO) Hexadeci
mal

➟12.4.1 ■7 Version device details ([IAI X-SEL 
Controller])

○ ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 For the program control device, the command to be sent differs depending on the write data.

Write data other than the followings are processed as an internal error of the GOT.
• Write data 0: Program Exit Command (0x254)
• Write data 1: Program Execution Command (0x253)
• Write data 2: Program Pause Command (0x255)
• Write data 3: Program 1 Step Execution Command (0x256)
• Write data 4: Program Restart Command (0x257)

*3 When software reset is performed, a no response error is displayed after a non-communicating period of ten and several 
seconds, and then the communication is resumed.

*4 For the device whose obtained data No.0 is a command trigger, a request is sent to the controller when the Write or Read 
is input to the command trigger.
It is not sent when the Clear is input.

■5 Axis Status device details ([IAI X-SEL Controller])
(1) Axis Status device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The axis status device format includes the following elements.

PGST Program Status Decimal ➟12.4.1 ■8 Program Status device details ([IAI X-
SEL Controller])

○ ×

SYST System Status Decimal ➟12.4.1 ■9 System Status device details ([IAI X-
SEL Controller])

○ ×

PRG*2 Program Control Decimal 000 to 128 ○ ×

AR Alarm Reset Decimal 0 × ×

SR*3 Software Reset Decimal 0 × ×

DSR Drive-Source Recovery Decimal 0 × ×

OPR Operation-Pause Reset Decimal 0 × ×

SV*4 Servo Decimal ➟12.4.1 ■10 Servo device details ([IAI X-SEL 
Controller])

○ ×

FRW*4 Write to Flash ROM Decimal ➟12.4.1 ■11 Write to Flash ROM device details ([IAI 
X-SEL Controller])

○ ×

RO*4 Return to Origin Decimal ➟12.4.1 ■12 Return to Origin device details ([IAI X-
SEL Controller])

○ ×

PNM*4 Point Number Movement Decimal ➟12.4.1 ■13 Point Number Movement device 
details ([IAI X-SEL Controller])

○ ×

OSC*4 Operation Stop/Cancel Decimal ➟12.4.1 ■14 Operation Stop/Cancel device details 
([IAI X-SEL Controller])

○ ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name Format

Axis Status
AXST(Obtained data)
Notation example: AXST00

Item Description

Obtained data

Setting range 00 to 2F

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■5 (2) Axis Status device definition ([IAI X-SEL Controller])
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(2) Axis Status device definition ([IAI X-SEL Controller])

Obtained data Device definition

00

- Single-axis: Axis Status

b0

Servo axis in use
• 0: Not in use
• 1: In use (moving or others)
"Servo axis in use" indicates that a given task has the right to use the applicable axis. Therefore, this bit will turn on in the 
following conditions.
• When an operation command involving axis movement is in progress (including when an axis is moving)
• Servo is starting up from an OFF state
• Servo is shutting down from an ON state (excluding emergency stop)
• Operation axis is paused

b1 to b2

Return to Origin
• 0: Not yet performed
• 1: Returning to origin
• 2. Completed

b3
Servo
• 0: OFF
• 1: ON

b4

Operation command successful completion
• 0: Not yet complete
• 1: Completed successfully
This can be used only to check the completion of the operation command.

b5
Push error detection
• 0: Not detected
• 1: Detected

b6 to b7 Reserved for system use

01

- Single-axis: Axis sensor input status

b0
Creep sensor
• 0: OFF
• 1: ON

b1
Overrun sensor
• 0: OFF
• 1: ON

b2
Origin sensor
• 0: OFF
• 1: ON

b3 Reserved for system use

02 Single-axis: Axis error code

03

- Single-axis: Encoder status

b0 Overspeed (OS)

b1 Full absolute status (FS)

b2 Count error (CE)

b3 Counter overflow (OF)

b4 Reserved for system use

b5 Multi-rotation error (ME)

b6 Battery error (BE)

b7 Battery alarm (BA)

04
Single-axis: Current position (lower 16 bits) unit (0.001 mm)
Indicates the lower 16 bits of the current position in hexadecimal.

05
Single-axis Current position (upper 16 bits) unit (0.001 mm)
Indicates the upper 16 bits of the current position in hexadecimal.

06 to 0B
Double axes data
For the device definitions, refer to the definitions of the single-axis status (00 to 05).

: :

2A to 2F
Eight axes status
For the device definitions, refer to the definitions of the single-axis status (00 to 05).
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■6 Scara Axis Status device details ([IAI X-SEL Controller])
(1) Scara Axis Status device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The SCARA axis status device formats include the following elements.

(2) Scara Axis Status device definition ([IAI X-SEL Controller])

Device name Format

Scara Axis Status 0 (Base coordinate system)
SAXS0(Obtained data)
Notation example: SAXS004

Scara Axis Status 1 (Selected work coordinate 
system)

SAXS1(Obtained data)
Notation example: SAXS104

Scara Axis Status 2 (Reserved for system use)
SAXS2(Obtained data)
Notation example: SAXS204

Scara Axis Status 3 (Each axis system)
SAXS3(Obtained data)
Notation example: SAXS304

Item Description

Obtained data

Setting range 00 to FF

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■6 (2) Scara Axis Status device definition ([IAI X-SEL Controller])

Obtained data Device definition

00 Work coordinate system selection number

01 Tool coordinate system selection number

02

- Common axis status

b0 to b1

Scara axis current arm system
• 0: Base coordinate system
• 1: Selected work coordinate system
• 2: Reserved for system use
• 3: Each axis system

b2 to b3

Scara axis current position coordinate system type
• 0: Right arm system
• 1: Left arm system
• 2: Indeterminable
• 3: Reserved for system use

b4 to b7 Reserved for system use

03

Axis pattern

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0
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04

- Single-axis: Axis Status

b0

Servo axis in use
• 0: Not in use
• 1: In use (moving or others)
"Servo axis in use" indicates that a given task has the right to use the applicable axis. Therefore, this bit will turn on in the 
following conditions.
• When an operation command involving axis movement is in progress (including when an axis is moving)
• Servo is starting up from an OFF state
• Servo is shutting down from an ON state (excluding emergency stop)
• Operation axis is paused

b1 to b2

Return to Origin
• 0: Not yet performed
• 1: Returning to origin
• 2. Completed

b3
Servo
• 0: OFF
• 1: ON

b4

Operation command successful completion
• 0: Not yet complete
• 1: Completed successfully
This can be used only to check the completion of the operation command.
For positioning that includes any of the X, Y and R axes, make sure to check completion for all of the X, Y and R axes.

b5
Push error detection
• 0: Not detected
• 1: Detected

b6 to b7 Reserved for system use

05

- Single-axis: Axis sensor input status

b0
Creep sensor
• 0: OFF
• 1: ON

b1
Overrun sensor
• 0: OFF
• 1: ON

b2
Origin sensor
• 0: OFF
• 1: ON

b3 Reserved for system use

06 Single-axis: Axis error code

07

- Single-axis: Encoder status

b0 Overspeed (OS)

b1 Full absolute status (FS)

b2 Count error (CE)

b3 Counter overflow (OF)

b4 Reserved for system use

b5 Multi-rotation error (ME)

b6 Battery error (BE)

b7 Battery alarm (BA)

08
Single-axis: Current position (lower 16 bits) unit (0.001 mm or 0.001 deg)
Indicates the lower 16 bits of the current position in hexadecimal.

09
Single-axis: Current position (upper 16 bits) unit (0.001 mm or 0.001 deg)
Indicates the upper 16 bits of the current position in hexadecimal.

0A to 0F
Double axes data
For the device definitions, refer to the definitions of the single-axis status (04 to 09).

: :

2E to 33
Eight axes data
For the device definitions, refer to the definitions of the single-axis status (04 to 09).

34 to FF Reserved for system use

Obtained data Device definition
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■7 Version device details ([IAI X-SEL Controller])
(1) Version device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The version device formats include the following elements.

(2) Version device definition ([IAI X-SEL Controller])

■8 Program Status device details ([IAI X-SEL Controller])
(1) Program Status device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The program status format includes the following elements.

Device name Format

Version 0 (Main CPU application)
VR0(Device No.):(Obtained data)
Notation example: VR0F:0

Version 1 (Main CPU core)
VR1(Device No.):(Obtained data)
Notation example: VR1F:0

Version 2 (Driver CPU)
VR2(Device No.):(Obtained data)
Notation example: VR2F:0

Version 3 (Mount SIO)
VR3(Device No.):(Obtained data)
Notation example: VR3F:0

Item Description

Device No.

Setting range 0 to F

Device No. 
representation Hexadecimal

Obtained data

Setting range 0 to F

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■7 (2) Version device definition ([IAI X-SEL Controller])

Obtained data Device definition

0 Model code

1 Unit code

2 Version number

3 Time (year)

4 Time (month)

5 Time (day)

6 Time (hour)

7 Time (min)

8 Time (sec)

9 to F Reserved for system use

Device name Format

Program Status
PGST (Obtained data)
Notation example: PGST000

Item Description

Obtained data

Setting range 000 to 511

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■8 (2) Program Status device definition ([IAI X-SEL Controller])
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(2) Program Status device definition ([IAI X-SEL Controller])

■9 System Status device details ([IAI X-SEL Controller])
(1) System Status device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The system status device format includes the following elements.

(2) System Status device definition ([IAI X-SEL Controller])

Obtained data Device definition

000

- Program number 1: Status

b0
Startup
• 0: Not started
• 1: Started

b1 to b3 Reserved for system use

001 Program number 1: Execution program step number

002 Program number 1: Program-dependent error code

003 Program number 1: Error occurrence step number

004 to 007
Data of program number 2
For the device definitions, refer to the definitions of Program number 1 (000 to 003).

: :

508 to 511
Data of program number 128
For the device definitions, refer to the definitions of Program number 1 (000 to 003).

Device name Format

System Status
SYST(Obtained data)
Notation example: SYST0

Item Description

Obtained data

Setting range 0 to 6

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■9 (2) System Status device definition ([IAI X-SEL Controller])

Obtained data Device definition

0

System mode
• 0: Indeterminable
• 1: AUTO mode
• 2: MANUAL mode
• 3: Slave update mode
• 4: Core update mode

1 Critical level system error number

2 Latest system error number
12. APPENDICES
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3

- System status byte 1

b0
Operation mode switch status
• 0: AUTO
• 1: MANUAL

b1

TP enable switch status
• 0: ON
• 1: OFF
X-SEL (P/Q series) (Multi axes/Scara)/ SSEL / ASEL / PSEL: This bit is disabled (fixed to 0).

b2

Safety gate status
• 0: CLOSE
• 1: OPEN
X-SEL (P/Q series) (Multi axes/Scara) / SSEL / ASEL / PSEL: This bit indicates the status of the enable switch or deadman 
switch.

b3
Emergency stop switch status
• 0: No emergency stop
• 1: Emergency stop

b4
Power error status
• 0: Normal
• 1: Error

b5
Battery voltage low warning status
• 0: Not low
• 1: Low

b6
Battery voltage error status
• 0: No error
• 1: Error

b7 Reserved for system use

4

- System status byte 2

b0

Application data flash ROM write status
• 0: Not writing/erasing
• 1: Writing/erasing
When the core program is in operation (Application update mode), only Bit 0 is enabled.
Data for System mode, Critical level system error number, Latest system error number, System status byte 1, System status 
byte 3 and System status byte 4 is disabled.

b1
Slave parameter writing status
• 0: Not writing
• 1: Writing

b2
Servo interlock status
• 0: No interlock
• 1: Interlock

b3
I/O interlock status
• 0: No interlock
• 1: Interlock

b4
Restart wait status
• 0: Not waiting
• 1: Waiting

b5
Program run status
• 0: Not run
• 1: Running

b6 to b7 Reserved for system use

Obtained data Device definition
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■10 Servo device details ([IAI X-SEL Controller])
(1) Servo device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The servo device format includes the following elements.

(2) Servo device definition ([IAI X-SEL Controller])

5

- System status byte 3

b0
Drive-source cutoff status
• 0: Not cut off
• 1: Cut off

b1
System operation status
• 0: Not operating in AUTO mode
• 1: Operating in AUTO mode

b2
System ready status
• 0: Not ready
• 1: Ready

b3 Reserved for system use

b4
Operation mode
• 0: Program mode
• 1: Position mode

b5 to b7 Reserved for system use

6
System status byte 4
Reserved for system use

Obtained data Device definition

Device name Format

Servo
SV(Obtained data)
Notation example: SV0

Item Description

Obtained data

Setting range 0 to 2

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■10 (2) Servo device definition ([IAI X-SEL Controller])

Obtained data Device definition

0
Servo: Command trigger
• 1: Write
• 4: Clear

1

Servo: Axis pattern

2

- Servo: Operation type

b0
Servo ON/OFF
• 0: OFF
• 1: ON

b1 to b3
Reserved for system use
Fixed to 0

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0
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■11 Write to Flash ROM device details ([IAI X-SEL Controller])
(1) Write to Flash ROM device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The write to flash ROM device format includes the following elements.

(2) Write to Flash ROM device definition ([IAI X-SEL Controller])

■12 Return to Origin device details ([IAI X-SEL Controller])
(1) Return to Origin device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The return to origin device format includes the following elements.

(2) Return to Origin device definition ([IAI X-SEL Controller])

Device name Format

Write to Flash ROM
FRW(Obtained data)
Notation example: FRW0

Item Description

Obtained data

Setting range 0 to 1

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■11 (2) Write to Flash ROM device definition ([IAI X-SEL Controller])

Obtained data Device definition

0
Write to Flash ROM: Command trigger
• 1: Write

1 Reserved for system use

Device name Format

Return to Origin
RO(Obtained data)
Notation example: RO0

Item Description

Obtained data

Setting range 0 to 3

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■12 (2) Return to Origin device definition ([IAI X-SEL Controller])

Obtained data Device definition

0
Return to Origin: Command trigger
• 1: Write
• 4: Clear

1

Return to Origin: Axis pattern
For the XSEL-JX/KX/KTX/PX/QX series controller, specify a linear drive axis only.

2
Return to Origin: End search speed unit (mm/sec)
When it is zero, the parameter value is enabled.

3
Return to Origin: Creep speed unit (mm/sec)
When it is zero, the parameter value is enabled.

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0
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■13 Point Number Movement device details ([IAI X-SEL Controller])
(1) Point Number Movement device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The point number movement device format includes the following elements.

(2) Point Number Movement device definition ([IAI X-SEL Controller])

■14 Operation Stop/Cancel device details ([IAI X-SEL Controller])
(1) Operation Stop/Cancel device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The operation stop/cancel device format includes the following elements.

Device name Format

Point Number Movement
PNM(Obtained data)
Notation example: PNM0

Item Description

Obtained data

Setting range 0 to 5

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■13 (2) Point Number Movement device definition ([IAI X-SEL Controller])

Obtained data Device definition

0
Point Number Movement: Command trigger
• 1: Write
• 4: Clear

1

Point Number Movement: Axis pattern

2
Point Number Movement: Acceleration unit (0.01 G)
When the setting value of the acceleration is zero, the relevant setting value of the position data is effective.
When the setting value of the acceleration and the relevant setting value are both zero, the parameter value is effective.

3
Point Number Movement: Deceleration unit (0.01 G)
When the setting value of the deceleration is zero, the relevant setting value of the position data is effective.
When the setting value of the deceleration and the relevant setting value are both zero, the parameter value is effective.

4

Point Number Movement: Speed unit (mm/sec)
When the setting value of the speed is zero, the relevant setting value of the position data is effective.
When the setting value of the speed and the relevant setting value are both zero, the parameter value is effective.
The safety limit value is applied depending on the mode.

5 Point Number Movement: Point number

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0

Device name Format

Operation Stop/Cancel
OSC(Obtained data)
Notation example: OSC0

Item Description

Obtained data

Setting range 0 to 2

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■14 (2) Operation Stop/Cancel device definition ([IAI X-SEL Controller])
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(2) Operation Stop/Cancel device definition ([IAI X-SEL Controller])

■15 Availability of writing/reading data to/from word devices ([IAI X-SEL Controller])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■16 Monitoring-supported double-word devices ([IAI X-SEL Controller])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

Obtained data Device definition

0
Operation Stop/Cancel: Command trigger
• 1: Write
• 4: Clear

1

Operation Stop/Cancel: Stop axis pattern
Including during-interlock-pending servo command cancelation

2

- Operation Stop/Cancel: Additional command

b0
During-interlock-pending output (out port) (during all operation pause) cancellation instruction
• 0: Non-cancellation
• 1: Temporary cancellation

b1 to b7
Reserved for system use
Fixed to 0

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PDT R/- -/- -/- -/-

STR R/W -/- -/- -/-

AXST R/- -/- -/- -/-

SAXS0 R/- -/- -/- -/-

SAXS1 R/- -/- -/- -/-

SAXS2 R/- -/- -/- -/-

SAXS3 R/- -/- -/- -/-

VR0 R/- -/- -/- -/-

VR1 R/- -/- -/- -/-

VR2 R/- -/- -/- -/-

VR3 R/- -/- -/- -/-

PGST R/- -/- -/- -/-

SYST R/- -/- -/- -/-

PRG -/W -/- -/- -/-

AR -/W -/- -/- -/-

SR -/W -/- -/- -/-

DSR -/W -/- -/- -/-

OPR -/W -/- -/- -/-

SV R/W -/- -/- -/-

FRW -/W -/- -/- -/-

RO R/W -/- -/- -/-

PNM R/W -/- -/- -/-

OSC R/W -/- -/- -/-
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➟12.4.1 ■22 Availability of writing/reading data to/from double-word devices ([IAI X-SEL Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 For the device whose obtained data No.0 is a command trigger, a request is sent to the controller when the Write or Read 

is input to the command trigger.
It is not sent when the Clear is input.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

CD0
Coordinate Affiliate Data 
0 (Work coordinate 
system definition data)

Hexadeci
mal

➟12.4.1 ■17 Coordinate Affiliate Data device 
details ([IAI X-SEL Controller])

× ×

CD1
Coordinate Affiliate Data 
1 (Tool coordinate 
system definition data)

Hexadeci
mal

➟12.4.1 ■17 Coordinate Affiliate Data device 
details ([IAI X-SEL Controller])

× ×

INT Integer Decimal

INT(Program No.):(Variable No.)
Notation example: INT128:0200

× ×Global area
• Program No. (decimal): 000
• Variable No. (decimal): 0200 to 0299 

, 1200 to 1299

Local area
• Program No. (decimal): 001 to 128
• Variable No. (decimal): 0001 to 0099 

, 1001 to 1099

RL Real Decimal

RL(Program No.):(Variable No.)
Notation example: RL000:1399

× ×Global area
• Program No. (decimal): 000
• Variable No. (decimal): 0300 to 

0399, 1300 to 1399

Local area
• Program No. (decimal): 001 to 128
• Variable No. (decimal): 0100 to 

0199, 1100 to 1199

ER0 Error Detail 0 (System 
error)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER1 Error Detail 1 (Axis-
specific error)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER2 Error Detail 2 (Program-
specific error)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER3 Error Detail 3 (Error in 
error list record)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER4 Error Detail 4 (Reserved 
for system use)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER5 Error Detail 5 (Reserved 
for system use)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER6 Error Detail 6 (Reserved 
for system use)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

ER7 Error Detail 7 (Reserved 
for system use)

Hexadeci
mal

➟12.4.1 ■18 Error Detail device details ([IAI X-SEL 
Controller])

× ×

PD Point Data Hexadeci
mal

➟12.4.1 ■19 Point Data device details ([IAI X-SEL 
Controller])

× ×

SD Simple Interference 
Check Zone Data

Hexadeci
mal

➟12.4.1 ■20 Simple Interference Check Zone Data 
device details ([IAI X-SEL Controller])

× ×

JIM Jogging/Inching 
Movement Decimal ➟12.4.1 ■21 Jogging/Inching Movement device 

details ([IAI X-SEL Controller])
× ×
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■17 Coordinate Affiliate Data device details ([IAI X-SEL Controller])
(1) Coordinate Affiliate Data device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The Coordinate Affiliate Data device formats include the following elements.

(2) Coordinate Affiliate Data device definition ([IAI X-SEL Controller])

■18 Error Detail device details ([IAI X-SEL Controller])
(1) Error Detail device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

Device name Format

Coordinate Affiliate Data 0 (Work coordinate system 
definition data)

CD0(Definition data No.):(Obtained data)
Notation example: CD0FF:0

Coordinate Affiliate Data 1 (Tool coordinate system 
definition data)

CD1(Definition data No.):(Obtained data)
Notation example: CD1FF:0

Item Description

Definition data number

Setting range 00 to FF

Device No. 
representation Hexadecimal

Obtained data

Setting range 0 to F

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■17 (2) Coordinate Affiliate Data device definition ([IAI X-SEL Controller])

Obtained data Device definition

0 X axis coordinate offset

1 Y axis coordinate offset

2 Z axis coordinate offset

3 R axis coordinate offset

4 to F Reserved for system use

Device name Format

Error Detail 0 (System error)
ER0(Type2):(Reserved for system use):(Obtained data)
Notation example: ER0FF:000:00

Error Detail 1 (Axis-specific error)
ER1(Type2):(Reserved for system use):(Obtained data)
Notation example: ER1FF:000:00

Error Detail 2 (Program-specific error)
ER2(Type2):(Reserved for system use):(Obtained data)
Notation example: ER2FF:000:00

Error Detail 3 (Error in error list record)
ER3(Type2):(Reserved for system use):(Obtained data)
Notation example: ER3FF:000:00

Error Detail 4 (Reserved for system use)
ER4(Type2):(Reserved for system use):(Obtained data)
Notation example: ER4FF:000:00

Error Detail 5 (Reserved for system use)
ER5(Type2):(Reserved for system use):(Obtained data)
Notation example: ER5FF:000:00

Error Detail 6 (Reserved for system use)
ER6(Type2):(Reserved for system use):(Obtained data)
Notation example: ER6FF:000:00

Error Detail 7 (Reserved for system use)
ER7(Type2):(Reserved for system use):(Obtained data)
Notation example: ER7FF:000:00
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The Error Detail device formats include the following elements.

(2) Error Detail device definition ([IAI X-SEL Controller])

Item Description

Type 2

Setting range 00 to FF

Device No. 
representation Hexadecimal

Explanation

System error
• 0: Critical level error
• 1: Latest error

Axis-specific error: Axis number

Program-specific error: Program number

Error in error list record: Record number (1 or later)

Reserved for system use

Setting range 000

Device No. 
representation Hexadecimal

Obtained data

Setting range 00 to FF

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■18 (2) Error Detail device definition ([IAI X-SEL Controller])

Obtained data Device definition

00 Error No.

01

Detail information 1
Other than system-down level error: Program number
(Error source is indicated if the step number is not 0.)
System-down level error: System down type

02
Detail information 2
Other than system-down level error: Step number (Error source)
System-down level error: System down error code

03
Detail information 3
Other than system-down level error: Axis number
System-down level error: System down information 1

04
Detail information 4
Other than system-down level error: Point number (Negative value at interpolation point)
System-down level error: System down information 2

05 Detail information 5

06 Detail information 6

07 Detail information 7

08 Detail information 8

09 Message bytes

0A Message 1

0B Message 2

: :

49 Message 64

50 to FF Reserved for system use
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■19 Point Data device details ([IAI X-SEL Controller])
(1) Point Data device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The Point Data device format includes the following elements.

(2) Point Data device definition ([IAI X-SEL Controller])

Device name Format

Point Data
PD(Obtained data)
Notation example: PD00

Item Description

Obtained data

Setting range 00 to 9E

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■19 (2) Point Data device definition ([IAI X-SEL Controller])

Obtained data Device definition

00

Point Data: Command trigger
• 1: Write
• 2: Read
• 4: Clear

01 Point Data: Starting point number

02 Point Data: Number of point data

03 Point Data 1: Point number

04

Point Data 1: Axis pattern

05 Point Data 1: Acceleration unit (0.01 G)

06 Point Data 1: Deceleration unit (0.01 G)

07 Point Data 1: Speed unit (mm/sec)

08 Point Data 1: 1st axis position data unit (0.001 mm)

09 Point Data 1: 2nd axis position data unit (0.001 mm)

0A Point Data 1: 3rd axis position data unit (0.001 mm)

0B Point Data 1: 4th axis position data unit (0.001 mm)

0C Point Data 1: 5th axis position data unit (0.001 mm)

0D Point Data 1: 6th axis position data unit (0.001 mm)

0E Point Data 1: 7th axis position data unit (0.001 mm)

0F Point Data 1: 8th axis position data unit (0.001 mm)

10 to 1C
Data of Point Data 2
For the device definition, refer to the definition of Point Data 1 (03 to 0F).

: :

92 to 9E
Data of Point Data 12
For the device definition, refer to the definition of Point Data 1 (03 to 0F).

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0
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■20 Simple Interference Check Zone Data device details ([IAI X-SEL Controller])
(1) Simple Interference Check Zone Data device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The Simple Interference Check Zone Data device format includes the following elements.

(2) Simple Interference Check Zone Data device definition ([IAI X-SEL Controller])

■21 Jogging/Inching Movement device details ([IAI X-SEL Controller])
(1) Jogging/Inching Movement device format ([IAI X-SEL Controller])

The following shows the format in the setting dialog of an object or others.

The Jogging/Inching Movement device format includes the following elements.

Device name Format

Simple Interference Check Zone Data
SD(Definition data No.):(Obtained data)
Notation example: SDFF:0

Item Description

Definition data number

Setting range 01 to FF

Device No. 
representation Hexadecimal

Obtained data

Setting range 0 to F

Device No. 
representation Hexadecimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■20 (2) Simple Interference Check Zone Data device definition ([IAI X-SEL 
Controller])

Obtained data Device definition

0 Effective axis pattern

1 Simple interference check zone definition coordinate 1 X axis unit (0.001 mm (R axis: 0.001 deg))

2 Simple interference check zone definition coordinate 1 Y axis unit (0.001 mm (R axis: 0.002 deg))

3 Simple interference check zone definition coordinate 1 Z axis unit (0.001 mm (R axis: 0.003 deg))

4 Simple interference check zone definition coordinate 1 R axis unit (0.001 mm (R axis: 0.004 deg))

5 Simple interference check zone definition coordinate 2 X axis unit (0.001 mm (R axis: 0.001 deg))

6 Simple interference check zone definition coordinate 2 Y axis unit (0.001 mm (R axis: 0.002 deg))

7 Simple interference check zone definition coordinate 2 Z axis unit (0.001 mm (R axis: 0.003 deg))

8 Simple interference check zone definition coordinate 2 R axis unit (0.001 mm (R axis: 0.004 deg))

9 Physical output port number or global flag number for output upon entry

A

Entry error type specification
• 0: No error handling
• 1: Message-level error
• 2: Operation-cancellation level error

B to F Reserved for system use

Device name Format

Jogging/Inching Movement
JIM(Obtained data)
Notation example: JIM0

Item Description

Obtained data

Setting range 0 to 6

Device No. 
representation Decimal

Explanation
For the device definitions, refer to the following.

➟12.4.1 ■21 (2) Jogging/Inching Movement device definition ([IAI X-SEL Controller])
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(2) Jogging/Inching Movement device definition ([IAI X-SEL Controller])

Obtained data Device definition

0
Jogging/Inching Movement: Command trigger
• 1: Write
• 4: Clear

1

Jogging/Inching Movement: Axis pattern
For SCARA controllers, only one SCARA axis can be specified. (Multiple axes cannot be specified.)
For SCARA controllers, jog/inch commands are available only when all SCARA servo axes are in non-operating state.
For X-SEL-PX/QX/RX/SX controllers, simultaneous specification of SCARA and linear drive axes is prohibited.

2
Jogging/Inching Movement: Acceleration unit (0.01 G (% for each axis))
When it is zero, the parameter value is enabled.

3
Jogging/Inching Movement: Deceleration unit (0.01 G (% for each axis))
When it is zero, the parameter value is enabled.

4
Jogging/Inching Movement: Speed unit (mm/sec (% for each axis))
When it is zero, the parameter value is enabled.
(The safety limit value is applied depending on the mode.)

5
Jogging/Inching Movement: Inch distance unit (0.001 mm (0.001 deg for each axis))
An absolute value is specified.
When it is zero, no distance is specified (= Jog).

6

- Jogging/Inching Movement: Operation type

b0
Jog/inch direction
• 0: Coordinate - Direction
• 1: Coordinate + Direction

b1 to b2

Jog/inch movement coordinate system (dedicated to SCARA)
• 0: Base coordinate system
• 1: Selected work coordinate system
• 2: Selected work coordinate system
• 3: Each axis system

b3
Reserved for system use
Fixed to 0

Bit
1st axis
8th axis
Reserved for system use

- 7 6 5 4 3 2 1 0
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■22 Availability of writing/reading data to/from double-word devices ([IAI X-SEL Controller])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

CD0 -/- R/- -/- -/-

CD1 -/- R/- -/- -/-

INT -/- R/W -/- -/-

RL -/- R/W -/- -/-

ER0 -/- R/- -/- -/-

ER1 -/- R/- -/- -/-

ER2 -/- R/- -/- -/-

ER3 -/- R/- -/- -/-

ER4 -/- R/- -/- -/-

ER5 -/- R/- -/- -/-

ER6 -/- R/- -/- -/-

ER7 -/- R/- -/- -/-

PD -/- R/W -/- -/-

SD -/- R/- -/- -/-

JIM -/- R/W -/- -/-
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12.4.2 IAI equipment ([IAI ROBO CYLINDER])

■1 Device setting dialog ([IAI ROBO CYLINDER])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of S0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [0] to [15] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([IAI ROBO CYLINDER])
5) [Switch to the device define dialog]

You can open the device definition setting dialog to check the definition of the device.
➟6.1.6 ■6 Device definition setting dialog

Item Reference

Device setting dialog ➟■1 Device setting dialog ([IAI ROBO CYLINDER])

Specifications of bit devices

➟■2 Monitoring-supported bit devices ([IAI ROBO CYLINDER])

➟■3 Status device definition ([IAI ROBO CYLINDER])

➟■4 Availability of writing/reading data to/from bit devices ([IAI ROBO CYLINDER])

Specifications of word devices

➟■5 Monitoring-supported word devices ([IAI ROBO CYLINDER])

➟■6 Registers device definition ([IAI ROBO CYLINDER])

➟■7 Availability of writing/reading data to/from word devices ([IAI ROBO CYLINDER])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

S0000

Device name
Device number
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(1) Indirect specification of a station number ([IAI ROBO CYLINDER])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported bit devices ([IAI ROBO CYLINDER])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.2 ■4 Availability of writing/reading data to/from bit devices ([IAI ROBO CYLINDER])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Status device definition ([IAI ROBO CYLINDER])
Not available to the RCON series.

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [15]
Setting a value outside the above range causes a timeout error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

S Status Hexadeci
mal

0000 to FFFF
For the device definitions, refer to the 
following.

➟12.4.2 ■3 Status device definition ([IAI 
ROBO CYLINDER])

○
○
(Not usable as 
word data)

Status Device definition Symbol

0000 to 00FF - (Reserved for system use) -

0100 EMG status EMGS

0101 Safety speed enabled status SFTY

0102 Controller ready status PWR

0103 Servo ON status SV

0104 Missed work in push-motion operation PSFL

0105 Major failure status ALMH

0106 Minor failure status ALML

0107 Absolute error status ABER

0108 Brake forced-release status BKRL

0109 Use prohibited -

010A Pause status STP

010B Home return status HEND

010C Position complete status PEND

010D Load cell calibration complete CEND

010E Load cell calibration status CLBS

010F to 0111 Use prohibited -

0112 Load output judgment status LOAD

0113 Torque level status TRQS
12. APPENDICES
12.4 Device Range and Settings of Each Controller

12 - 511



0114 Teaching mode status MODS

0115 Position-data load command status TEAC

0116 Jog + status JOG+

0117 Jog - status JOG-

0118 Position complete 7 PE7

0119 Position complete 6 PE6

011A Position complete 5 PE5

011B Position complete 4 PE4

011C Position complete 3 PE3

011D Position complete 2 PE2

011E Position complete 1 PE1

011F Position complete 0 PE0

0120 Emergency stop status EMGP

0121 Motor voltage low status MPUV

0122 Operation mode status RMDS

0123 Use prohibited -

0124 Home returning status GHMS

0125 Push-motion operation in progress PUSH

0126 Excitation detection status PSNS

0127 PIO/Modbus switching status PMSS

0128 to 0129 Use prohibited -

012A Moving signal MOVE

012B to 0135 Use prohibited -

0136 Position complete number status bit 512 PM512

0137 Completed position number status bit 256 PM256

0138 Position complete number status bit 128 PM128

0139 Position complete number status bit 64 PM64

013A Position complete number status bit 32/Executed program number status bit 32 PM32

013B Position complete number status bit 16/Executed program number status bit 16 PM16

013C Position complete number status bit 8/Executed program number status bit 8 PM8

013D Position complete number status bit 4/Executed program number status bit 4 PM4

013E Position complete number status bit 2/Executed program number status bit 2 PM2

013F Position complete number status bit 1/Executed program number status bit 1 PM1

0140 Use prohibited -

0141 Limit sensor output monitor 2 LS2

0142 Limit sensor output monitor 1 LS1

0143 Limit sensor output monitor 0 LS0

0144 to 0146 Use prohibited -

0147 Position zone output monitor ZP

0148 to 014D Use prohibited -

014E Zone output monitor 2 Z2

014F Zone output monitor 1 Z1

0150 to 015F PIO connector pin number 20A(IN15) to PIO connector pin number 5A(IN0) -

0160 to 016F PIO connector pin number 16B(OUT15) to PIO connector pin number 1B(OUT0) -

0170 Use prohibited

0171 Command pulse NP signal status NP

0172 Use prohibited -

Status Device definition Symbol
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0173 Command pulse PP signal status PP

0174 to 0176 Use prohibited -

0177 Mode switch status MDSW

0178 to 017A Use prohibited -

017B Belt breakage sensor monitor BLCT

017C Home-check sensor monitor HMCK

017D Overtravel sensor OT

017E Creep sensor CREP

017F Limit sensor LS

0180 to 0183 Use prohibited -

0184 Cold start level alarm ALMC

0185 to 0186 Use prohibited -

0187 RTC in use (ERC3, ACON-CA/CB and PCON-CA/CFA/CB/CFB only) RTC

0188 to 0190 Use prohibited -

0191 Waiting WAIT

0192 While in returning operation RTRN

0193 While in depression operation DCMP

0194 Pressurize during the stop PSTP

0195 While in pressurizing operation PRSS

0196 While in probing operation SERC

0197 While in approaching the operation APRC

0198 to 019A Use prohibited -

019B Program home return during the movement MPHM

019C Program alarm PALM

019D Program finished in normal condition PCMP

019E While in executing program PRUN

019F Program home position PORG

01A0 to 01A9 Use prohibited -

01AA Load judgment NG LJNG

01AB Load judgment OK LJOK

01AC Position (distance) judgment NG PJNG

01AD Position (distance) judgment OK PJOK

01AE Total judgment NG JDNG

01AF Total judgment OK JDOK

01B0 to 03FF - (Reserved for system use) -

0400 EMG operation specification EMG

0401 Safety speed command SFTY

0402 Use prohibited -

0403 Servo ON command SON

0404 to 0406 Use prohibited -

0407 Alarm reset command ALRS

0408 Brake forced-release command BKRL

0409 Use prohibited -

040A Temporary stop command STP

040B Home return command HOME

040C Positioning start command CSTR

040D to 0410 Use prohibited -

Status Device definition Symbol
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■4 Availability of writing/reading data to/from bit devices ([IAI ROBO CYLINDER])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

0411 Jog/inch switching JISL

0412 to 0413 Use prohibited -

0414 Teaching mode command MOD

0415 Position data load command TEAC

0416 Jog + command JOG+

0417 Jog command JOG-

0418 Start position 7 ST7

0419 Start position 6 ST6

041A Start position 5 ST5

041B Start position 4 ST4

041C Start position 3 ST3

041D Start position 2 ST2

041E Start position 1 ST1

041F Start position 0 ST0

0420 to 0425 Use prohibited -

0426 Load cell calibration command CLBR

0427 PIO/Modbus switching specification PMSL

0428 to 042B Use prohibited -

042C Deceleration stop STOP

042D to 0435 Use prohibited -

0436 Position command bit 512 PC512

0437 Position command bit 256 PC256

0438 Position command bit 128 PC128

0439 Position command bit 64 PC64

043A Position command bit 32/Program number command bit 32 PC32

043B Position command bit 16/Program number command bit 16 PC16

043C Position command bit 8/Program number command bit 8 PC8

043D Position command bit 4/Program number command bit 4 PC4

043E Position command bit 2/Program number command bit 2 PC2

043F Position command bit 1/Program number command bit 1 PC1

0440 to 048F - (Reserved for system use) -

0490 to 049A Use prohibited -

049B Axis operation permission ENMV

049C Program home return movement PHOM

049D Search stop SSTP

049E Program compulsory finish FPST

049F Program start PSTR

04A0 to FFFF - (Reserved for system use) -

Status Device definition Symbol

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

S R/W -/- -/- -/- -/-
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■5 Monitoring-supported word devices ([IAI ROBO CYLINDER])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.2 ■7 Availability of writing/reading data to/from word devices ([IAI ROBO CYLINDER])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Registers device definition ([IAI ROBO CYLINDER])
(1) When using PCON, ACON, SCON, or ERC2

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

R Register Hexadeci
mal

0000 to FFFF
For the device definitions, refer to the 
following.

➟12.4.2 ■6 Registers device definition 
([IAI ROBO CYLINDER])

○ ○

Register Definition Symbol

0000 to 04FF - (Reserved for system use) -

0500 Alarm detail code ALA0

0501 Alarm address ALA0

0502 Always 0 -

0503 Alarm code ALC0

0504 Alarm occurrence time ALT0

0506 to 0CFF - (Reserved for system use) -

0D00 Device control register 1 DRG1

0D01 Device control register 2 DRG2

0D03 Position number specification register/Program number specification register POSR

0D04 to 0FFF - (Reserved for system use) -

1000 to 3FFE

For each position No., 15 points of word device 
are assigned.
***: 0 to 767
• Position No. 0: 1000 to 100E
• Position No. 1: 1010 to 101E

:
• Position No. 767: 3FF0 to 3FFE

Position No.***: Target position (upper 16 bits) PCMD

Position No.***: Target position (lower 16 bits) PCMD

Position No.***: Positioning band (upper 16 bits) INP

Position No.***: Positioning band (lower 16 bits) INP

Position No.***: Speed command (upper 16 bits) VCMD

Position No.***: Speed command (lower 16 bits) VCMD

Position No.***: Individual zone boundary + 
(upper 16 bits) ZNMP

Position No.***: Individual zone boundary + 
(lower 16 bits) ZNMP

Position No.***: Individual zone boundary - 
(upper 16 bits) ZNLP

Position No.***: Individual zone boundary - 
(lower 16 bits) ZNLP

Position No.***: Acceleration command ACMD

Position No.***: Deceleration command DCMD

Position No.***: Push-current limiting value PPOW

Position No.***: Load current threshold LPOW

Position No.***: Control flag specification CTLF

4000 to 83FF - (Reserved for system use) -
12. APPENDICES
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8400 Total moving count (upper 16 bits) TLMC

8401 Total moving count (lower 16 bits) TLMC

8402 Total moving distance (upper 16 bits) ODOM

8403 Total moving distance (lower 16 bits) ODOM

841E Current time (SCON-CA/CAL/CB only) (upper 16 bits) TIMN

841F Current time (SCON-CA/CAL/CB only) (lower 16 bits) TIMN

8420 Current time (PCON-CA/CFA/CB/CFB only) (upper 16 bits) TIMN

8421 Current time (PCON-CA/CFA/CB/CFB only) (lower 16 bits) TIMN

8422 Current time (ACON-CA/CB only) (upper 16 bits) TIMN

8423 Current time (ACON-CA/CB only) (lower 16 bits) TIMN

842A Total FAN driving time (SCON-CAL, SCON-CB [400W or more] only) (upper 16 bits) TFAN

842B Total FAN driving time (SCON-CAL, SCON-CB [400W or more] only) (lower 16 bits) TFAN

842E Total FAN driving time (PCON-CFA/CFB only) (upper 16 bits) TFAN

842F Total FAN driving time (PCON-CFA/CFB only) (lower 16 bits) TFAN

8430 to 8FFF - (Reserved for system use) -

9000 Current position register (upper 16 bits) PNOW

9001 Current position register (lower 16 bits) PNOW

9002 Present alarm code register ALMC

9003 Input port register DIPM

9004 Output port register DOPM

9005 Device status 1 register DSS1

9006 Device status 2 register DSS2

9007 Expansion device status register DSSE

9008 System status register (upper 16 bits) STAT

9009 System status register (lower 16 bits) STAT

900A Current speed monitor register (upper 16 bits) VNOW

900B Current speed monitor register (lower 16 bits) VNOW

900C Current ampere monitor register (upper 16 bits) CNOW

900D Current ampere monitor register (lower 16 bits) CNOW

900E Deviation monitor register (upper 16 bits) DEVI

900F Deviation monitor register (lower 16 bits) DEVI

9010 System timer register (upper 16 bits) STIM

9011 System timer register (lower 16 bits) STIM

9012 Special input port register SIPM

9013 Zone status register ZONS

9014 Positioning complete position No. register/Executed program No. register POSS

9015 Expansion System status register SSSE

9016 to 901D - (Reserved for system use) -

901E Current load (SCON-CA/CB only) (upper 16 bits) FBFC

901F Current load (SCON-CA/CB only) (lower 16 bits) FBFC

9020 Overload level monitor (upper 16 bits) OLLV

9021 Overload level monitor (lower 16 bits) OLLV

9022 Press program alarm code ALMP

9023 Press program alarm generated program No. ALMP

9024 Press program status register PPST

9025 Press program judgment status register PPJD

9026 to 97FF - (Reserved for system use) -

Register Definition Symbol
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9800 Position movement command register POSR

9801 to 98FF - (Reserved for system use) -

9900 Target position coordinate specification register (upper 16 bits) PCMD

9901 Target position coordinate specification register (lower 16 bits) PCMD

9902 Positioning band specification register (upper 16 bits) INP

9903 Positioning band specification register (lower 16 bits) INP

9904 Speed specification register (upper 16 bits) VCMD

9905 Speed specification register (lower 16 bits) VCMD

9906 Acceleration speed specification register ACMD

9907 Push-current limiting value PPOW

9908 Control flag specification register CTLF

9909 to FFFF - (Reserved for system use) -

Register Definition Symbol
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(2) When using RCON

Register Definition Symbol

0000 to 0CFF - (Reserved for system use) -

0D00 Device control register 1 DRG1

0D01 Device control register 2 DRG2

0D02 to 8FFF - (Reserved for system use) -

9000 Absolute Position Counter Current Position(Higher 16bit) PNOW

9001 Absolute Position Counter Current Position(Lower 16bit) PNOW

9002 Currently Occurred Alarm Code ALMC

9005 Device Status Register 1 DSS1

9006 Device Status Register 2 DSS2

9007 Extension Device Status Register DSSE

9008 System status(Higher 16bit) STAT

9009 System status(Lower 16bit) STAT

900A Current Velocity Monitor(Higher 16bit) VNOW

900B Current Velocity Monitor(Lower 16bit) VNOW

900C Current (Torque Current)(Higher 16bit) CNOW

900D Current (Torque Current)(Lower 16bit) CNOW

900E Deviation Monitor(Higher 16bit) DEVI

900F Deviation Monitor(Lower 16bit) DEVI

9010 System Timer(Higher 16bit) STIM

9011 System Timer(Lower 16bit) STIM

9012 Special Input Port Monitoring Register SIPM

9013 Zone status register ZONS

9014 Position Number Status Register POSS

9015 Expansion System status register SSSE

901A Feedback urgent (Torque Current)(Higher 16bit) CNWF

901B Feedback urgent (Torque Current)(Lower 16bit) CNWF

901C to 901F - (Reserved for system use) -

9020 Overload level monitor (upper 16 bits) OLLV

9021 Overload level monitor (lower 16 bits) OLLV

9030 to 92FF - (Reserved for system use) -

9300 Total moving count(Higher 16bit) TTIM

9301 Total moving count(Lower 16bit) TTIM

9302 Total drive distance(Higher 16bit) ODOM

9303 Total drive distance(Lower 16bit) ODOM

9304 Max. Drive Supply Voltage FMAX

9305 Max. Control Voltage VMAX

9306 Max. Motor Current(Higher 16bit) CMAX

9307 Max. Motor Current(Lower 16bit) CMAX

9308 Total conducting time(Higher 16bit) TTIM

9309 Total conducting time(Lower 16bit) TTIM

930A Emergency Stop Input Count(Higher 16bit) EMGC

930B Emergency Stop Input Count(Lower 16bit) EMGC

930C Average PCB Temperature TEMP

930D Max. PCB Temperature TEMP

930E Max. PCB Temperature Detected Time(Higher 16bit) TTPM

930F Max. PCB Temperature Detected Time(Lower 16bit) TTPM
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9311 Max. Motor Overload Ratio OLMX

9312 Max. Motor Overload Ratio Detected Time(Higher 16bit) TOLM

9313 Max. Motor Overload Ratio Detected Time(Lower 16bit) TOLM

9014 to 93FF - (Reserved for system use) -

9400 Serial code 1(Higher 16bit) CTS1

9401 Serial code 1(Lower 16bit) CTS1

9402 Serial code 2(Higher 16bit) CTS2

9403 Serial code 2(Lower 16bit) CTS2

9404 Serial code 3(Higher 16bit) CTS3

9405 Serial code 3(Lower 16bit) CTS3

9406 Serial code 4(Higher 16bit) CTS4

9407 Serial code 4(Lower 16bit) CTS4

9800 Position Number Indication Register POSR

9801 to 98FF - (Reserved for system use) -

9900 Target position coordinate specification register (upper 16 bits) PCMD

9901 Target position coordinate specification register (lower 16 bits) PCMD

9902 Positioning band specification register (upper 16 bits) INP

9903 Positioning band specification register (lower 16 bits) INP

9904 Speed specification register (upper 16 bits) VCMD

9905 Speed specification register (lower 16 bits) VCMD

9906 Acceleration speed specification register ACMD

9907 Push-current limiting value PPOW

9908 Control flag specification register CTLF

9909 to 99FF - (Reserved for system use) -

9A00 Target Position Indication Register(Higher 16bit) PCMD

9A01 Target Position Indication Register(Lower 16bit) PCMD

9A02 Position Number Indication Register (except for target position) PPOS

9A03 to FFFF - (Reserved for system use) -

Register Definition Symbol
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■7 Availability of writing/reading data to/from word devices ([IAI ROBO CYLINDER])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

R R/W R/W -/- R/W
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12.4.3 AZBIL equipment ([Azbil SDC/DMC])

■1 Device setting dialog ([Azbil SDC/DMC])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..273

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [0] to [127] (direct) or [200] to [215] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([Azbil SDC/DMC])

(1) Indirect specification of a station number ([Azbil SDC/DMC])
When you specify any of 200 to 215 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Azbil SDC/DMC])

Specifications of word devices
➟■2 Monitoring-supported word devices ([Azbil SDC/DMC])

➟■3 Availability of writing/reading data to/from word devices ([Azbil SDC/DMC])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

..273

Device name
Device number

Station No. GOT data register (GD) Setting range

200 GD10

[0] to [127]
Setting a value outside the above range causes a device range error.

201 GD11

: :

214 GD24

215 GD25
12. APPENDICES
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■2 Monitoring-supported word devices ([Azbil SDC/DMC])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.3 ■3 Availability of writing/reading data to/from word devices ([Azbil SDC/DMC])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from word devices ([Azbil SDC/DMC])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

.. Data Decimal 273 to 31243 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

.. R/W -/- -/- R/W
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12.4.4 AZBIL equipment ([Azbil DMC50])

■1 Device setting dialog ([Azbil DMC50])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of NA0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify the station number of a COM module or control equipment.
The setting range is [1] to [15] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([Azbil DMC50])
5) [Sub Station No.]

Specify the sub station number of the control equipment that is connected to the COM module specified with 
[Station].
The setting range is [0] to [15].
If [Sub Station No.] is set to 0, the GOT monitors the COM module or the control equipment specified with [Station].
For AHC2001, [Sub Station No.] is ignored.

6) [Switch to the device define dialog]
You can open the device definition setting dialog to check the definition of the device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Azbil DMC50])

Specifications of double-word 
devices

➟■2 Monitoring-supported double-word devices ([Azbil DMC50])

➟■3 Network Addresses device definition ([Azbil DMC50])

➟■4 Parameter Addresses device definition ([Azbil DMC50])

➟■5 Availability of writing/reading data to/from double-word devices ([Azbil DMC50])

Precautions ➟■6 Precautions ([Azbil DMC50])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

NA0000

Device name
Device number
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➟6.1.6 ■6 Device definition setting dialog

(1) Indirect specification of a station number ([Azbil DMC50])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The upper 8 bits of the value in the GOT data register are regarded as the station number, and the lower 8 bits are 
regarded as the sub station number.
When a GD device is used as the station number, the setting of [Sub Station No.] becomes invalid.
The following shows the relationship between the specified station number and the GOT data register (GD).

Example) When [Station] is set to 100
The value of GD10 determines the control equipment to be monitored.
GD10 = 0 × 010A
(Upper 8 bits) 0 × 01 → Station No.: 1
(Lower 8 bits) 0 × 0A → Sub station No.: 10

■2 Monitoring-supported double-word devices ([Azbil DMC50])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.4 ■5 Availability of writing/reading data to/from double-word devices ([Azbil DMC50])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Network Addresses device definition ([Azbil DMC50])

■4 Parameter Addresses device definition ([Azbil DMC50])

Station No. GOT data register (GD) Setting range

100 GD10

0x0000 to 0xFFFF

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

NA Network Addresses Hexadeci
mal

0000 to FFFF
For the device definitions, refer to the 
following.

➟12.4.4 ■3 Network Addresses device 
definition ([Azbil DMC50])

× ×

PA Parameter Addresses Hexadeci
mal

(Parameter type ID)(Device)
• Parameter type ID: 001 to 9FF
• Device: 00000 to FFFFF
For the definitions of the parameter type 
IDs, refer to the following.

➟12.4.4 ■4 Parameter Addresses device 
definition ([Azbil DMC50])

× ×

Network Addresses Definition

0000 Network Addresses

Parameter type ID Definition

001 H/W Information

002 Date and Time Setup

021 AI Setup (High resolution type: standard inputs)
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022 AI Setup (Special type)

023 AI Setup (High resolution type: option inputs)

041 AUX-IN Setup

045 AO Setup

061 DO Setup

071 TP Setup

074 Zener Barrier Adjustment Values

0A1 ME20X Communication Setup

0A2 MR20X Communication Setup

0A3 Front Port Communication Setup

0C1 System Status

0C3 Date and Time Display

0C4 System Alarm Log

0C5 AI Alarm Log

0C6 AUX-IN Alarm Log

0E1 AI Status

0E2 AUX-IN Status

0E3 AO Status

0E5 DI Status

0E6 DO Status

0E7 TP Status

0E8 Zener Barrier Adjustment Counts

0F1 Present ME20X Communication Setup

0F2 Present MR20X Communication Setup

0F3 Front Port Active Communication Setup

103 Memory Usage Monitor

201 PID_A Options

202 PID_A Constants

203 PID_A Monitor

211 PID_CAS Options

212 PID_CAS Constants (master)

213 PID_CAS Constants (slave)

214 PID_CAS Monitor

234 Ra_PID Options

235 Ra_PID Constants

236 Ra_PID Monitor

241 UP_PID Options

242 UP_PID Constants

243 UP_PID Monitor

301 TBL/TBR Setup

C00 Pattern Setup

C01 to C63 Segment Setup

CF1 Pattern FB Monitor

801 to 9FF Type label defined by the user

Parameter type ID Definition
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■5 Availability of writing/reading data to/from double-word devices ([Azbil DMC50])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Precautions ([Azbil DMC50])
(1) Station No. and sub station No. of AZBIL DMC50

The station number and the sub station number set for the AZBIL DMC50 are equivalent to the network number and the 
station number set for the MITSUBISHI ELECTRIC PLC, respectively.
To set the control equipment to be monitored, set both the station number and the sub station number.

(2) Restrictions for the faulty station information, the control equipment, and servo amplifier monitor 
station disconnection
When the DMC50 is used, the GOT only monitors some stations.
For the details of the station numbers of the DMC50 to be monitored, refer to the following.

➟12.1.3 ■4 Read device list

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

NA -/- R/W -/- -/-

PA -/- R/- -/- -/-
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12.4.5 OMRON equipment ([OMRON SYSMAC])

■1 Device setting dialog ([OMRON SYSMAC])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

■2 Monitoring-supported bit devices ([OMRON SYSMAC])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([OMRON SYSMAC])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([OMRON SYSMAC])

➟■3 Availability of writing/reading data to/from bit devices ([OMRON SYSMAC])

Specifications of word devices
➟■4 Monitoring-supported word devices ([OMRON SYSMAC])

➟■5 Availability of writing/reading data to/from word devices ([OMRON SYSMAC])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

..000000

Device name
Device number
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➟12.4.5 ■3 Availability of writing/reading data to/from bit devices ([OMRON SYSMAC])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([OMRON SYSMAC])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

.. I/O relay, Internal auxiliary relay Decimal

..(Channel No.)(Bit No.)
Notation example: ..614300
The two rightmost digits represent a bit 
number.
• Channel No. (decimal): 0000 to 6143
• Bit No.: 00 to 15

○ ○

LR Data link relay Decimal

LR(Channel No.)(Bit No.)
Notation example: LR19900
The two rightmost digits represent a bit 
number.
• Channel No. (decimal): 000 to 199
• Bit No.: 00 to 15

○ ○

HR Holding relay Decimal

HR(Channel No.)(Bit No.)
Notation example: HR51100
The two rightmost digits represent a bit 
number.
• Channel No. (decimal): 000 to 511
• Bit No.: 00 to 15

○ ○

WR Internal auxiliary relay, Work relay Decimal

WR(Channel No.)(Bit No.)
Notation example: WR51100
The two rightmost digits represent a bit 
number.
• Channel No. (decimal): 000 to 511
• Bit No.: 00 to 15

○ ○

TIM Timer contact Decimal 0 to 4095 ○ ○

CNT Counter contact Decimal 0 to 4095 ○ ○

AR Auxiliary memory relay Decimal

AR(Channel No.)(Bit No.)
Notation example: AR1153500
The two rightmost digits represent a bit 
number.
• Channel No. (decimal): 00000 to 11535
• Bit No.: 00 to 15

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

.. R/W -/- R/W R/W -/-

LR R/W -/- R/W R/W -/-

HR R/W -/- R/W R/W -/-

WR R/W -/- R/W R/W -/-

TIM R/- -/- R/- R/- -/-

CNT R/- -/- R/- R/- -/-

AR R/W -/- R/W R/W -/-
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■4 Monitoring-supported word devices ([OMRON SYSMAC])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.5 ■5 Availability of writing/reading data to/from word devices ([OMRON SYSMAC])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Writing or reading data extending across banks is not possible.
*3 A valid value ranges from 0 to 9999.

(This applies to the 16 bit/32 bit device data.)
*4 This is handled as a BCD value in the PLC. When serial connection is used between the PLC and the GOT, this is handled 

as an unsigned 16-bit binary data in the GOT.
For the object for monitoring on the GOT, select [Unsigned BIN16] for [Data Type].

■5 Availability of writing/reading data to/from word devices ([OMRON SYSMAC])
The following shows whether writing/reading data to/from word devices is available by device type.
When executing the touch switch function that has been set during the bit specification of the word device, do not write 
any data to the word device through the sequence program.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TIM Timer (current value)*3*4 Decimal 0 to 4095 ○ ○

CNT Counter (current value)*3*4 Decimal 0 to 4095 ○ ○

DM Data memory Decimal 0 to 32767 ○ ○

EM*2 Extension data memory, EM 
current bank Decimal 0 to 32767 ○ ○

E*2 Extension data memory
Hexadeci
mal + 
decimal

E(Bank No.)-(Device)
Notation example: E18-100
• Bank No. (hexadecimal): 0 to 18
• Device (decimal): 0 to 32767

○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TIM R/W R/W -/- R/W

CNT R/W R/W -/- R/W

DM R/W R/W -/- R/W

EM R/W R/W -/- R/W

E R/W R/W -/- R/W
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12.4.6 OMRON equipment ([OMRON NJ/NX])

Not available to GT2105-Q.

■1 Device setting dialog ([OMRON NJ/NX])
Set a device to be monitored.
In the device setting dialog, only GOT internal devices are settable.
For setting the OMRON NJ/NX tags, refer to the following.

➟6.1.7 How to set OMRON NJ/NX tags

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported devices ([OMRON NJ/NX])
To monitor the OMRON NJ or NX series, use OMRON NJ/NX tags.
For the usable OMRON NJ/NX tags, refer to the following.

➟6.1.7 ■1 Usable OMRON NJ/NX tags

Item Reference

Device setting dialog ➟■1 Device setting dialog ([OMRON NJ/NX])

Device specifications ➟■2 Monitoring-supported devices ([OMRON NJ/NX])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)
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12.4.7 OMRON equipment ([OMRON THERMAC/INPANEL NEO])

■1 Device setting dialog ([OMRON THERMAC/INPANEL NEO])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of S0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Monitor target specification
Set the monitoring target of the set device.

5) [Station No.]

Item Reference

Device setting dialog ➟■1 Device setting dialog ([OMRON THERMAC/INPANEL NEO])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([OMRON THERMAC/INPANEL NEO])

➟■3 Availability of writing/reading data to/from bit devices ([OMRON THERMAC/INPANEL NEO])

Specifications of word devices
➟■4 Monitoring-supported word devices ([OMRON THERMAC/INPANEL NEO])

➟■5 Availability of writing/reading data to/from word devices ([OMRON THERMAC/INPANEL NEO])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([OMRON THERMAC/INPANEL NEO])

➟■7 Availability of writing/reading data to/from double-word devices ([OMRON THERMAC/INPANEL NEO])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[All]

Select this when writing data to all temperature controllers.
During monitoring, the temperature controller of station No. 1 is monitored.
When writing the data in numerical input, data is written to all connected temperature 
controllers during input, and the temperature controller of station No. 1 is monitored during 
other than input (displaying).

[Selection] Select this item when monitoring the indicating controller that has the specified station 
number.

2) 3)

4)

1)

5)

S0000

Device name
Device number
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This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [99] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([OMRON THERMAC/INPANEL NEO])

(1) Indirect specification of a station number ([OMRON THERMAC/INPANEL NEO])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the relationship between the specified station number and the GOT data register (GD).

■2 Monitoring-supported bit devices ([OMRON THERMAC/INPANEL NEO])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.7 ■3 Availability of writing/reading data to/from bit devices ([OMRON THERMAC/INPANEL NEO])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([OMRON THERMAC/INPANEL 
NEO])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([OMRON THERMAC/INPANEL NEO])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.7 ■5 Availability of writing/reading data to/from word devices ([OMRON THERMAC/INPANEL NEO])
For the formats of devices, refer to the following.

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [99]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

S Status Decimal

S(Channel No.)(Bit No.)
Notation example: S0100
• Channel No. (decimal): 00 to 01
• Bit No. (decimal): 00 to 31

○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

S R/- -/- -/- -/- -/-
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Numerical input cannot be used.

Use a word switch for writing.

■5 Availability of writing/reading data to/from word devices ([OMRON THERMAC/INPANEL 
NEO])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Monitoring-supported double-word devices ([OMRON THERMAC/INPANEL NEO])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.7 ■7 Availability of writing/reading data to/from double-word devices ([OMRON THERMAC/INPANEL 
NEO])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

A*2 Operation command Hexadeci
mal 0000 to 0011 ○

○
(Not usable as bit 
data)

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

A -/W -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

C0 Variable area 0
Decimal + 
hexadecim
al

C0(Channel No.)(Address)
Notation example: C00100
• Channel No. (decimal): 00 to 01
• Address (hexadecimal): 00 to 13

× ×

C1 Variable area 1
Decimal + 
hexadecim
al

C1(Channel No.)(Address)
Notation example: C10100
• Channel No. (decimal): 00 to 01
• Address (hexadecimal): 00 to 31

× ×

C3 Variable area 3
Decimal + 
hexadecim
al

C3(Channel No.)(Address)
Notation example: C30100
• Channel No. (decimal): 00 to 01
• Address (hexadecimal): 00 to 83

× ×
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■7 Availability of writing/reading data to/from double-word devices ([OMRON THERMAC/
INPANEL NEO])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

C0 -/- R/- -/- -/-

C1 -/- R/W -/- -/-

C3 -/- R/W -/- -/-
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12.4.8 OMRON equipment ([OMRON Digital Temperature Controller])

■1 Device setting dialog ([OMRON Digital Temperature Controller])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of SC0000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Monitor target specification
Set the monitoring target of the set device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([OMRON Digital Temperature Controller])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([OMRON Digital Temperature Controller])

➟■3 Availability of writing/reading data to/from bit devices ([OMRON Digital Temperature Controller])

Specifications of word devices
➟■4 Monitoring-supported word devices ([OMRON Digital Temperature Controller])

➟■5 Availability of writing/reading data to/from word devices ([OMRON Digital Temperature Controller])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([OMRON Digital Temperature Controller])

➟■7 Availability of writing/reading data to/from double-word devices ([OMRON Digital Temperature 
Controller])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[All]

Select this when writing data to all temperature controllers.
During monitoring, the temperature controller of station No. 1 is monitored.
When writing the data in numerical input, data is written to all connected temperature 
controllers during input, and the temperature controller of station No. 1 is monitored during 
other than input (displaying).

[Selection] Select this item when monitoring the indicating controller that has the specified station 
number.

2) 3)

4)

1)

5)

SC0000000

Device name
Device number
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5) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [99] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([OMRON Digital Temperature Controller])

(1) Indirect specification of a station number ([OMRON Digital Temperature Controller])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the relationship between the specified station number and the GOT data register (GD).

■2 Monitoring-supported bit devices ([OMRON Digital Temperature Controller])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.8 ■3 Availability of writing/reading data to/from bit devices ([OMRON Digital Temperature Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([OMRON Digital Temperature 
Controller])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([OMRON Digital Temperature Controller])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.8 ■5 Availability of writing/reading data to/from word devices ([OMRON Digital Temperature 

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [99]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

SC0 Status(Variable type C0)
Hexadeci
mal + 
decimal

SC0(Address No.)(Bit No.)
Notation example: SC0FFFF00
• Address number (hexadecimal): 0000 to 

FFFF
• Bit No. (decimal): 00 to 31

○
○
(Not usable as 
word data)

SC4 Status(Variable type C4)
Hexadeci
mal + 
decimal

SC4(Address No.)(Bit No.)
Notation example: SC4FFFF00
• Address number (hexadecimal): 0000 to 

FFFF
• Bit No. (decimal): 00 to 31

○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

SC0 R/- -/- -/- -/- -/-

SC4 R/- -/- -/- -/- -/-
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Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Numerical input cannot be used.

Use a word switch for writing.

■5 Availability of writing/reading data to/from word devices ([OMRON Digital Temperature 
Controller])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Monitoring-supported double-word devices ([OMRON Digital Temperature Controller])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.8 ■7 Availability of writing/reading data to/from double-word devices ([OMRON Digital Temperature 
Controller])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

A*2 Operation command Hexadeci
mal 0000 to 00FF ○

○
(Not usable as bit 
data)

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

A -/W -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

C0 Variable area C0 Hexadeci
mal 0000 to FFFF × ×

C1 Variable area C1 Hexadeci
mal 0000 to FFFF × ×

C3 Variable area C3 Hexadeci
mal 0000 to FFFF × ×

C4 Variable area C4 Hexadeci
mal 0000 to FFFF × ×

C5 Variable area C5 Hexadeci
mal 0000 to FFFF × ×

C6 Variable area C6 Hexadeci
mal 0000 to FFFF × ×

C7 Variable area C7 Hexadeci
mal 0000 to FFFF × ×

C8 Variable area C8 Hexadeci
mal 0000 to FFFF × ×

C9 Variable area C9 Hexadeci
mal 0000 to FFFF × ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([OMRON Digital 
Temperature Controller])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

CA Variable area CA Hexadeci
mal 0000 to FFFF × ×

CB Variable area CB Hexadeci
mal 0000 to FFFF × ×

CC Variable area CC Hexadeci
mal 0000 to FFFF × ×

CD Variable area CD Hexadeci
mal 0000 to FFFF × ×

CE Variable area CE Hexadeci
mal 0000 to FFFF × ×

CF Variable area CF Hexadeci
mal 0000 to FFFF × ×

D0 Variable area D0 Hexadeci
mal 0000 to FFFF × ×

D1 Variable area D1 Hexadeci
mal 0000 to FFFF × ×

D2 Variable area D2 Hexadeci
mal 0000 to FFFF × ×

D3 Variable area D3 Hexadeci
mal 0000 to FFFF × ×

D8 Variable area D8 Hexadeci
mal 0000 to FFFF × ×

D9 Variable area D9 Hexadeci
mal 0000 to FFFF × ×

DA Variable area DA Hexadeci
mal 0000 to FFFF × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

C0 -/- R/- -/- -/-

C1 -/- R/W -/- -/-

C3 -/- R/W -/- -/-

C4 -/- R/W -/- -/-

C5 -/- R/W -/- -/-

C6 -/- R/W -/- -/-

C7 -/- R/W -/- -/-

C8 -/- R/W -/- -/-

C9 -/- R/W -/- -/-

CA -/- R/W -/- -/-

CB -/- R/W -/- -/-

CC -/- R/W -/- -/-

CD -/- R/W -/- -/-

CE -/- R/W -/- -/-

CF -/- R/W -/- -/-
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D0 -/- R/W -/- -/-

D1 -/- R/W -/- -/-

D2 -/- R/W -/- -/-

D3 -/- R/W -/- -/-

D8 -/- R/W -/- -/-

D9 -/- R/W -/- -/-

DA -/- R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data
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12.4.9 KEYENCE equipment ([KEYENCE KV-700/1000/3000/5000/7000/8000])

■1 Device setting dialog ([KEYENCE KV-700/1000/3000/5000/7000/8000])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([KEYENCE KV-700/1000/3000/5000/7000/8000])

Specifications of bit devices

➟■2 Monitoring-supported bit devices ([KEYENCE KV-700/1000/3000/5000/7000/8000])

➟■3 Availability of writing/reading data to/from bit devices ([KEYENCE KV-700/1000/3000/5000/7000/
8000])

Specifications of word devices

➟■4 Monitoring-supported word devices ([KEYENCE KV-700/1000/3000/5000/7000/8000])

➟■5 Availability of writing/reading data to/from word devices ([KEYENCE KV-700/1000/3000/5000/7000/
8000])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([KEYENCE KV-700/1000/3000/5000/7000/8000])

➟■7 Availability of writing/reading data to/from double-word devices ([KEYENCE KV-700/1000/3000/5000/
7000/8000])

Precautions ➟■8 Precautions ([KEYENCE KV-700/1000/3000/5000/7000/8000])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

..000000

Device name
Device number
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6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

■2 Monitoring-supported bit devices ([KEYENCE KV-700/1000/3000/5000/7000/8000])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.9 ■3 Availability of writing/reading data to/from bit devices ([KEYENCE KV-700/1000/3000/5000/7000/
8000])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When communication is performed through the following extension unit, the readable/writable device range is 00000 to 

99915.
• KV-L2□V
• KV-LE2□V
• KV-EP21V

*3 Monitoring by GOT is possible only when a device is used in the sequence program.
*4 In writing, only resetting of a contact is possible.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

..*2 Relay Decimal

..(Channel No.)(Bit No.)
Notation example: ..199900
• Channel No. (decimal): 0000 to 1999
• Bit No. (decimal): 00 to 15

○ ×

B*3 Link relay Hexadeci
mal 0000 to 7FFF ○ ×

MR*2 Internal auxiliary relay Decimal

MR(Channel No.)(Bit No.)
Notation example: MR399900
• Channel No. (decimal): 0000 to 3999
• Bit No. (decimal): 00 to 15

○ ×

LR Latch relay Decimal

LR(Channel No.)(Bit No.)
Notation example: LR99900
• Channel No. (decimal): 000 to 999
• Bit No. (decimal): 00 to 15

○ ×

T*3 Timer (contact) Decimal 0000 to 3999 ○ ×

C*3 Counter (contact) Decimal 0000 to 3999 ○ ×

CR Control relay Decimal

CR(Channel No.)(Bit No.)
Notation example: CR8900
• Channel No. (decimal): 00 to 89
• Bit No. (decimal): 00 to 15

○ ×

CTC*3*4 High-speed counter comparators 
(contact) Decimal 0 to 7 × ×

VB*3 Work relay Hexadeci
mal 0000 to F9FF ○ ×
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■3 Availability of writing/reading data to/from bit devices ([KEYENCE KV-700/1000/3000/5000/
7000/8000])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([KEYENCE KV-700/1000/3000/5000/7000/8000])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.9 ■5 Availability of writing/reading data to/from word devices ([KEYENCE KV-700/1000/3000/5000/
7000/8000])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

.. R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

MR R/W -/- R/W R/W -/-

LR R/W -/- R/W R/W -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

CR R/W -/- R/W R/W -/-

CTC R/W -/- -/- -/- -/-

VB R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DM Data memory Decimal 00000 to 65534 ○ ○

CM Control memory Decimal 00000 to 11998 ○
○
(Not usable as bit 
data)

W Link register Hexadeci
mal 0000 to 7FFF ○ ○

EM Extension data memory Decimal 00000 to 65534 ○ ○

Z Index register Decimal 01 to 12 ○
○
(Not usable as bit 
data)

FM Extension data memory 2 Decimal 00000 to 32767 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The restrictions differ depending on GT Designer3 version.

• 1.250L or earlier: Continuous access across banks is not available.
• 1.255R or later: Access across banks is available only for the Ethernet connection.

■5 Availability of writing/reading data to/from word devices ([KEYENCE KV-700/1000/3000/
5000/7000/8000])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 With KV-3000 and KV-5000, Z devices cannot be specified as double-word (32-bit) data.
Use DZ devices.

■6 Monitoring-supported double-word devices ([KEYENCE KV-700/1000/3000/5000/7000/
8000])

The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.9 ■7 Availability of writing/reading data to/from double-word devices ([KEYENCE KV-700/1000/3000/
5000/7000/8000])

For the formats of devices, refer to the following.

ZF*2 File register Decimal

000000 to 032767
032768 to 065535
065536 to 098303
098304 to 131071
131072 to 163839
163840 to 196607
196608 to 229375
229376 to 262143
262144 to 294911
294912 to 327679
327680 to 360447
360448 to 393215
393216 to 425983
425984 to 458751
458752 to 491519
491520 to 524287

○ ○

TM Temporary data memory Decimal 000 to 511 ○
○
(Not usable as bit 
data)

VM Work memory Decimal 00000 to 63999 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

DM R/W R/W -/- R/W

CM R/W R/W -/- -/-

W R/W R/W -/- R/W

EM R/W R/W -/- R/W

Z*1 R/W R/W -/- -/-

FM R/W R/W -/- R/W

ZF R/W R/W -/- R/W

TM R/W R/W -/- -/-

VM R/W R/W -/- -/-
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Monitoring by GOT is possible only when a device is used in the sequence program.

■7 Availability of writing/reading data to/from double-word devices ([KEYENCE KV-700/1000/
3000/5000/7000/8000])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■8 Precautions ([KEYENCE KV-700/1000/3000/5000/7000/8000])
(1) Notation of KEYENCE equipment devices

The KEYENCE notation and XYM notation are available for the devices of KEYENCE PLCs.
The KEYENCE notation is used in GT Designer3.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TC*2 Timer (current value) Decimal 0000 to 3999 × ×

CC*2 Counter (current value) Decimal 0000 to 3999 × ×

TS*2 Timer (set value) Decimal 0000 to 3999 × ×

CS*2 Counter (set value) Decimal 0000 to 3999 × ×

CTH*2 High-speed counter (current 
value) Decimal 0 to 3 × ×

CTC*2 High-speed counter comparators 
(set value) Decimal 0 to 7 × ×

DZ Index register Decimal 01 to 12 × ×

TRM Digital trimmer Decimal 0 to 7 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TC -/- R/W -/- -/-

CC -/- R/W -/- -/-

TS -/- R/W -/- -/-

CS -/- R/W -/- -/-

CTH -/- R/W -/- -/-

CTC -/- R/W -/- -/-

DZ -/- R/W -/- -/-

TRM -/- R/- -/- -/-
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12.4.10 KOYO EI equipment ([KOYO KOSTAC/DL])

■1 Device setting dialog ([KOYO KOSTAC/DL])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [1] to [90].

■2 Monitoring-supported bit devices ([KOYO KOSTAC/DL])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.10 ■3 Availability of writing/reading data to/from bit devices ([KOYO KOSTAC/DL])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([KOYO KOSTAC/DL])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([KOYO KOSTAC/DL])

➟■3 Availability of writing/reading data to/from bit devices ([KOYO KOSTAC/DL])

Specifications of word devices

➟■4 Monitoring-supported word devices ([KOYO KOSTAC/DL])

➟■5 Device R definitions ([KOYO KOSTAC/DL])

➟■6 Availability of writing/reading data to/from word devices ([KOYO KOSTAC/DL])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

I0

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([KOYO KOSTAC/DL])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Read-only device for KOSTAC SU series

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input Octal 0 to 1777 ○
○
(Not usable as 
word data)

Q Output Octal 0 to 1777 ○
○
(Not usable as 
word data)

GI Link relay Octal 0 to 3777 ○
○
(Not usable as 
word data)

M Internal relay Octal 0 to 3777 ○
○
(Not usable as 
word data)

S Stage Octal 0 to 1777 ○
○
(Not usable as 
word data)

T Timer Octal 0 to 377 ○
○
(Not usable as 
word data)

C Counter Octal 0 to 377 ○
○
(Not usable as 
word data)

GQ Link output Octal 0 to 3777 ○
○
(Not usable as 
word data)

SP Special relay Octal 0 to 777 ○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-

GI R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

S R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

GQ R/W -/- -/- -/- -/-

SP*1 R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([KOYO KOSTAC/DL])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.10 ■6 Availability of writing/reading data to/from word devices ([KOYO KOSTAC/DL])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Device R definitions ([KOYO KOSTAC/DL])
➟(1) KOSTAC SU, PZ

(2) DirectLOGIC 05, DirectLOGIC 06
(3) DirectLOGIC 205 series

(1) KOSTAC SU, PZ

(2) DirectLOGIC 05, DirectLOGIC 06

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

R Data area Octal

0 to 41237
For the data area definitions, refer to the 
following.

➟12.4.10 ■5 Device R definitions ([KOYO 
KOSTAC/DL])

○
○
(Not usable as bit 
data)

Definition
Device range

SU-5E SU-6B SU-5M/6M PZ3

Timer (current 
value) 0 to 177 0 to 377 0 to 377 0 to 377

Preparatory register - - 400 to 677 -

Special register 1 - 700 to 737 700 to 777 -

Counter (current 
value) 1000 to 1177 1000 to 1177 1000 to 1377 1000 to 1177

Data register 1400 to 7377 1400 to 7377 1400 to 7377 1400 to 7377

Special register 7400 to 7777 7400 to 7777 7400 to 7777 7400 to 7777

Data register - 10000 to 17777 10000 to 36777 10000 to 17777

Special register - - 37000 to 37777 37000 to 37777

Link relay 40000 to 40037 40000 to 40077 40000 to 40177 -

Link output - - 40200 to 40377 -

Input 40400 to 40423 40400 to 40423 40400 to 40477 40400 to 40437

Output 40500 to 40523 40500 to 40523 40500 to 40577 40500 to 40537

Internal relay 40600 to 40677 40600 to 40677 40600 to 40777 40600 to 40677

Stage 41000 to 41077 41000 to 41077 41000 to 41077 41000 to 41037

Timer 41100 to 41117 41100 to 41117 41100 to 41117 41100 to 41117

Counter 41140 to 41147 41140 to 41147 41140 to 41157 41140 to 41147

Special relay 41200 to 41205 41200 to 41205 41200 to 41237 41200 to 41237

Special relay 41215 to 41234 41215 to 41234 - -

Definition
Device range

DirectLOGIC 05 DirectLOGIC 06

Timer (current 
value) 0 to 177 0 to 377

V-memory - 400 to 677
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(3) DirectLOGIC 205 series

System parameter - 700 to 777

Counter (current 
value) 1000 to 1177 1000 to 1177

V-memory 1200 to 7377 1200 to 7377

V-Memory (non-
volatile) 7400 to 7577 7400 to 7577

System parameter 7600 to 7777 7600 to 7777

V-memory - 10000 to 17777

System parameter - 36000 to 37777

Link relay - 40000 to 40177

Link output - 40200 to 40377

Input relay 40400 to 40417 40400 to 40437

Output relay 40500 to 40517 40500 to 40537

Internal relay 40600 to 40637 40600 to 40677

Stage 41000 to 41017 41000 to 41017

Timer 41100 to 41107 41100 to 41117

Counter 41140 to 41147 41140 to 41147

Special relay 41200 to 41237 41200 to 41237

Definition
Device range

D2-240 D2-250-1 D2-260

Timer (current 
value) 0 to 177 0 to 377 0 to 377

Data word - - 400 to 777

Counter (current 
value) 1000 to 1177 1000 to 1177 1000 to 1377

Data word 2000 to 3777 1400 to 7377 1400 to 7377

Data Words (non-
volatile) 4000 to 4377 - -

System parameter 7620 to 7637 7400 to 7777 7600 to 7777

System parameter 7746 to 7777 - -

Data word - 10000 to 17777 10000 to 35777

System parameter - 36000 to 37777 36000 to 37777

Link relay - - 40000 to 40077

Link output - - 40200 to 40377

Input 40400 to 40423 40400 to 40437 40400 to 40477

Output 40500 to 40523 40500 to 40537 40500 to 40577

Internal relay 40600 to 40617 40600 to 40677 40600 to 40777

Stage 41000 to 41037 41000 to 41077 41000 to 41077

Timer 41100 to 41107 41100 to 41117 41100 to 41117

Counter 41140 to 41147 41140 to 41147 41140 to 41157

Special relay 41200 to 41205 41200 to 41237 41200 to 41237

Special relay 41226 to 41230 - -

Definition
Device range

DirectLOGIC 05 DirectLOGIC 06
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■6 Availability of writing/reading data to/from word devices ([KOYO KOSTAC/DL])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 The GOT cannot write data to R7377 when SU-5M or SU-6M is used.
*2 The GOT cannot write data to devices from R7766 to R7774 (calendar area).

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

R*1*2 R/W R/W -/- -/-
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12.4.11 JTEKT equipment ([JTEKT TOYOPUC-PC])

■1 Device setting dialog ([JTEKT TOYOPUC-PC])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [00] to [37] (octal number).

■2 Monitoring-supported bit devices ([JTEKT TOYOPUC-PC])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.11 ■3 Availability of writing/reading data to/from bit devices ([JTEKT TOYOPUC-PC])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([JTEKT TOYOPUC-PC])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([JTEKT TOYOPUC-PC])

➟■3 Availability of writing/reading data to/from bit devices ([JTEKT TOYOPUC-PC])

Specifications of word devices
➟■4 Monitoring-supported word devices ([JTEKT TOYOPUC-PC])

➟■5 Availability of writing/reading data to/from word devices ([JTEKT TOYOPUC-PC])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

X000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X*2 Input relay Hexadeci
mal 000 to 7FF ○ ×

Y*2 Output relay Hexadeci
mal 000 to 7FF ○ ×

L Link relay Hexadeci
mal

P(Program No.)-L(Device)
Notation example: P1-L7FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 7FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

M Internal relay Hexadeci
mal

P(Program No.)-M(Device)
Notation example: P1-M7FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 7FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

K Keep relay Hexadeci
mal

P(Program No.)-K(Device)
Notation example: P1-K2FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 2FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

P Edge detection Hexadeci
mal

P(Program No.)-P(Device)
Notation example: P1-P1FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 1FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

T*2 Timer Hexadeci
mal

P(Program No.)-T(Device)
Notation example: P1-T1FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 1FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

C*2 Counter Hexadeci
mal

P(Program No.)-C(Device)
Notation example: P1-C1FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 1FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

V Special relay Hexadeci
mal

P(Program No.)-V(Device)
Notation example: P1-V0FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 000 to 0FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

EX*2 Extended input Hexadeci
mal 000 to 7FF ○ ×

EY*2 Extended output Hexadeci
mal 000 to 7FF ○ ×

EM Extended internal relay Hexadeci
mal 0000 to 1FFF ○ ×

EK Extended keep-relay Hexadeci
mal 000 to FFF ○ ×

EV Extended special relay Hexadeci
mal 000 to FFF ○ ×

ET*2 Extended timer Hexadeci
mal 000 to 7FF ○ ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Overlapped device specification of an input (X, EX, GX) and an output (Y, EY, GY), or a timer (T, ET) and a counter (C, EC) 

is not allowed.
Example) X0000 and Y0000, EX0000 and EY0000

*3 The device can be used only in the PC3JG separate mode.
Access to the device through a link module is not possible.

■3 Availability of writing/reading data to/from bit devices ([JTEKT TOYOPUC-PC])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

EC*2 Extended counter Hexadeci
mal 000 to 7FF ○ ×

EL Extended link relay Hexadeci
mal 0000 to 1FFF ○ ×

EP Extended edge detection Hexadeci
mal 000 to FFF ○ ×

GX*2*3 Extended input 2 Hexadeci
mal 0000 to FFFF ○ ×

GY*2*3 Extended output 2 Hexadeci
mal 0000 to FFFF ○ ×

GM*3 Extended internal relay 2 Hexadeci
mal 0000 to FFFF ○ ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

K R/W -/- R/W R/W -/-

P R/W -/- R/W R/W -/-

T R/W -/- R/W R/W -/-

C R/W -/- R/W R/W -/-

V R/W -/- R/W R/W -/-

EX R/W -/- R/W R/W -/-

EY R/W -/- R/W R/W -/-

EM R/W -/- R/W R/W -/-

EK R/W -/- R/W R/W -/-

EV R/W -/- R/W R/W -/-

ET R/W -/- R/W R/W -/-

EC R/W -/- R/W R/W -/-

EL R/W -/- R/W R/W -/-

EP R/W -/- R/W R/W -/-

GX R/W -/- R/W R/W -/-

GY R/W -/- R/W R/W -/-

GM R/W -/- R/W R/W -/-
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■4 Monitoring-supported word devices ([JTEKT TOYOPUC-PC])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.11 ■5 Availability of writing/reading data to/from word devices ([JTEKT TOYOPUC-PC])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The device can be used only in the PC3JG separate mode.

Access to the device through a link module is not possible.
*3 To store a setting value of T or C, use TCS.

The setting value of T or C is stored in TCS.
TCS cannot be used if T or C is not in a program.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

B File register Hexadeci
mal 0000 to 1FFF ○ ×

D Data register Hexadeci
mal

P(Program No.)-D(Device)
Notation example: P1-D2FFF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 0000 to 2FFF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

R Link register Hexadeci
mal

P(Program No.)-R(Device)
Notation example: P1-R07FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 0000 to 07FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

N Current value register Hexadeci
mal

P(Program No.)-N(Device)
Notation example: P1-N01FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 0000 to 01FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

S Special register Hexadeci
mal

P(Program No.)-S(Device)
Notation example: P1-S03FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 0000 to 03FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×

EN Extended present value register Hexadeci
mal 0000 to 07FF ○ ×

H Extended setup value register Hexadeci
mal 0000 to 07FF ○ ×

ES Extended special register Hexadeci
mal 0000 to 07FF ○ ×

U Extended data register Hexadeci
mal 0000 to 7FFF ○ ×

EB*2 Extended buffer register Hexadeci
mal 00000 to 1FFFF ○ ×

TCS*3 Setup value register Hexadeci
mal

P(Program No.)-TCS(Device)
Notation example: P1-TCS01FF
• Program No. (decimal): None, 1 to 3
• Device (hexadecimal): 0000 to 01FF
When "NONE" is shown for [Program No.], 
it is not necessary to set "P(Program No.)-".

○ ×
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■5 Availability of writing/reading data to/from word devices ([JTEKT TOYOPUC-PC])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

B R/W R/W -/- R/W

D R/W R/W -/- R/W

R R/W R/W -/- R/W

N R/W R/W -/- R/W

S R/W R/W -/- R/W

EN R/W R/W -/- R/W

H R/W R/W -/- R/W

ES R/W R/W -/- R/W

U R/W R/W -/- R/W

EB R/W R/W -/- -/-

TCS R/W -/- -/- -/-
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12.4.12 SHARP equipment ([SHARP JW])

■1 Device setting dialog ([SHARP JW])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..00000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([SHARP JW])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.12 ■3 Availability of writing/reading data to/from bit devices ([SHARP JW])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SHARP JW])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SHARP JW])

➟■3 Availability of writing/reading data to/from bit devices ([SHARP JW])

Specifications of word devices
➟■4 Monitoring-supported word devices ([SHARP JW])

➟■5 Availability of writing/reading data to/from word devices ([SHARP JW])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

..00000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 To use the device as word data, set an even number for the device address and set 0 (fixed) for the bit address.
*3 Device settings for T and C must not overlap one another in the same address range.

Even if the address ranges overlap one another, the GOT displays no error.
The GOT monitors the timer and counter devices according to their address range instead of their device name.
Accordingly, if a device invalid as a SHARP PLC parameter is specified on GT Designer3, the GOT monitors a different 
device that covers the address range of the specified device.
Example) Parameter settings on the SHARP PLC side: T0000 to T1000, C1001 to C1777
When "C0000" is set in GT Designer3, GOT will monitor "T0000".

*4 Writing is possible only while the CPU is running (while the timer and counter is in operation).

■3 Availability of writing/reading data to/from bit devices ([SHARP JW])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([SHARP JW])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.12 ■5 Availability of writing/reading data to/from word devices ([SHARP JW])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

..*2 Relay Octal

..(Device address)(Bit address)
Notation example: ..15770
The rightmost digit is a bit address.
• Device (octal): 0000 to 1577, 2000 to 7577
• Bit address (octal): 0 to 7

○ ○

T*3*4 Timer (contact) Octal 0000 to 1777 ○
○
(Not usable as 
word data)

C*3*4 Counter (contact) Octal 0000 to 1777 ○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

.. R/W -/- R/W R/W -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T*2 Timer (Current value) Octal 0000 to 1777 ○ ○

C*2 Counter (Current value) Octal 0000 to 1777 ○ ○

1*3 File register Octal 000000 to 177776 ○ ○

2*3 File register Octal 000000 to 177776 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Device settings for T and C must not overlap one another in the same address range.

Even if the address ranges overlap one another, the GOT displays no error.
The GOT monitors the timer and counter devices according to their address range instead of their device name.
Accordingly, if a device invalid as a SHARP PLC parameter is specified on GT Designer3, the GOT monitors a different 
device that covers the address range of the specified device.
Example) Parameter settings on the SHARP PLC side: T0000 to T1000, C1001 to C1777
When "C0000" is set in GT Designer3, GOT will monitor "T0000".

*3 The file register format includes the file number and the address.
Set the address with an even number.

*4 The register format includes the type and the address.
Set the address with an even number.

3*3 File register Octal 000000 to 177776 ○ ○

4*3 File register Octal 000000 to 177776 ○ ○

5*3 File register Octal 000000 to 177776 ○ ○

6*3 File register Octal 000000 to 177776 ○ ○

7*3 File register Octal 000000 to 177776 ○ ○

09*4 Register Octal 000 to 776 ○ ○

19*4 Register Octal 000 to 776 ○ ○

29*4 Register Octal 000 to 776 ○ ○

39*4 Register Octal 000 to 776 ○ ○

49*4 Register Octal 000 to 776 ○ ○

59*4 Register Octal 000 to 776 ○ ○

69*4 Register Octal 000 to 776 ○ ○

79*4 Register Octal 000 to 776 ○ ○

89*4 Register Octal 000 to 776 ○ ○

99*4 Register Octal 000 to 776 ○ ○

E0*4 Register Octal 000 to 776 ○ ○

E1*4 Register Octal 000 to 776 ○ ○

E2*4 Register Octal 000 to 776 ○ ○

E3*4 Register Octal 000 to 776 ○ ○

E4*4 Register Octal 000 to 776 ○ ○

E5*4 Register Octal 000 to 776 ○ ○

E6*4 Register Octal 000 to 776 ○ ○

E7*4 Register Octal 000 to 776 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

1000000

File number
Address

09000

Type
Address
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■5 Availability of writing/reading data to/from word devices ([SHARP JW])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

T R/W R/W -/- R/W

C R/W R/W -/- R/W

1 R/W R/W -/- R/W

2 R/W R/W -/- R/W

3 R/W R/W -/- R/W

4 R/W R/W -/- R/W

5 R/W R/W -/- R/W

6 R/W R/W -/- R/W

7 R/W R/W -/- R/W

09 R/W R/W -/- R/W

19 R/W R/W -/- R/W

29 R/W R/W -/- R/W

39 R/W R/W -/- R/W

49 R/W R/W -/- R/W

59 R/W R/W -/- R/W

69 R/W R/W -/- R/W

79 R/W R/W -/- R/W

89 R/W R/W -/- R/W

99 R/W R/W -/- R/W

E0 R/W R/W -/- R/W

E1 R/W R/W -/- R/W

E2 R/W R/W -/- R/W

E3 R/W R/W -/- R/W

E4 R/W R/W -/- R/W

E5 R/W R/W -/- R/W

E6 R/W R/W -/- R/W

E7 R/W R/W -/- R/W
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12.4.13 SHINKO equipment ([Shinko Technos Controller])

■1 Device setting dialog ([Shinko Technos Controller])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..0001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Monitor target specification
Set the monitoring target of the set device.

5) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [95] (direct) or [100] to [115] (indirect).
For the monitor target specified when [95] is selected, refer to the description for [All].

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Shinko Technos Controller])

Specifications of word devices
➟■2 Monitoring-supported word devices ([Shinko Technos Controller])

➟■3 Availability of writing/reading data to/from word devices ([Shinko Technos Controller])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[All]

Select this item when writing data to all the connected indicating controllers.
During monitoring, the indicating controller set for [Host Address] of the [Controller Setting] 
window is monitored.
When data is input from a numerical input object, the data is written to all the connected 
indicating controllers. When no data is input, the controller set for [Host Address] is 
monitored.

[Selection] Select this item when monitoring the indicating controller that has the specified station 
number.

2) 3)

4)

1)

5)

..0001

Device name
Device number
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For indirect specification of a station number, refer to the following.
➟(1) Indirect specification of a station number ([Shinko Technos Controller])

(1) Indirect specification of a station number ([Shinko Technos Controller])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the relationship between the specified station number and the GOT data register (GD).

■2 Monitoring-supported word devices ([Shinko Technos Controller])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.13 ■3 Availability of writing/reading data to/from word devices ([Shinko Technos Controller])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from word devices ([Shinko Technos Controller])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [94]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

.. Data Hexadeci
mal

M(Memory No.)/..(Device)
Notation example: M7/..0001
• Memory No.: None, 0 to 7
• Device: 0001 to 7901
When "NONE" is shown for [Memory No.], it 
is not necessary to set "M(Memory No.)/".

○ ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

.. R/W -/- -/- R/W
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12.4.14 CHINO equipment ([CHINO MODBUS device])

■1 Device setting dialog ([CHINO MODBUS device])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of 00001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Monitor target specification
Set the monitoring target of the set device.

5) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [99] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([CHINO MODBUS device])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([CHINO MODBUS device])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([CHINO MODBUS device])

➟■3 Availability of writing/reading data to/from bit devices ([CHINO MODBUS device])

Specifications of word devices
➟■4 Monitoring-supported word devices ([CHINO MODBUS device])

➟■5 Availability of writing/reading data to/from word devices ([CHINO MODBUS device])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[All]

Select this item when writing data to all the connected controllers.
During monitoring, the controller set for [Host Address] of the [Controller Setting] window 
is monitored.
When data is input from a numerical input object, the data is written to all the connected 
controllers. When no data is input, the controller set for [Host Address] is monitored.

[Selection] Select this item when monitoring the controller that has the specified station number.

2) 3)

4)

1)

5)

00001

Device name
Device number
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(1) Indirect specification of a station number ([CHINO MODBUS device])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported bit devices ([CHINO MODBUS device])
The following table shows monitoring-supported bit devices.
Devices are set with reference numbers.
For parameters corresponding to each reference number, refer to the following.

➟Manual of the controller used
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.14 ■3 Availability of writing/reading data to/from bit devices ([CHINO MODBUS device])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([CHINO MODBUS device])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([CHINO MODBUS device])
The following table shows monitoring-supported word devices.
Devices are set with reference numbers.
For parameters corresponding to each reference number, refer to the following.

➟Manual of the controller used
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.14 ■5 Availability of writing/reading data to/from word devices ([CHINO MODBUS device])
For the formats of devices, refer to the following.

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [99]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

0 Digital parameter Decimal 0001 to 9999 ○ ○

1 Digital input data Decimal 0001 to 9999 ○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

0 R/W -/- -/- -/- -/-

1 R/- -/- -/- -/- -/-
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([CHINO MODBUS device])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

3 Analog input data Decimal 0001 to 9999 ○ ○

4 Analog parameter Decimal 0001 to 9999 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

3 R/- R/- -/- R/-

4 R/W R/W -/- R/W
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12.4.15 TOSHIBA equipment ([TOSHIBA PROSEC T/V])

■1 Device setting dialog ([TOSHIBA PROSEC T/V])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([TOSHIBA PROSEC T/V])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.15 ■3 Availability of writing/reading data to/from bit devices ([TOSHIBA PROSEC T/V])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The notation of device setting is different between the TOSHIBA PLC peripheral software and GOT.
For the notation of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([TOSHIBA PROSEC T/V])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([TOSHIBA PROSEC T/V])

➟■3 Availability of writing/reading data to/from bit devices ([TOSHIBA PROSEC T/V])

Specifications of word devices
➟■4 Monitoring-supported word devices ([TOSHIBA PROSEC T/V])

➟■5 Availability of writing/reading data to/from word devices ([TOSHIBA PROSEC T/V])

Notation of devices ➟■6 Notation of devices ([TOSHIBA PROSEC T/V])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

X0000

Device name
Device number
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➟12.4.15 ■6 Notation of devices ([TOSHIBA PROSEC T/V])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Although the device is defined as D in the manual of TOSHIBA PLC, R is used for setting as it is used for computer link 

connection.
*3 The GOT reads the value from a device and then write a value to the device.

Do not change the device value with a sequence program until the GOT completes writing a value to the device.

■3 Availability of writing/reading data to/from bit devices ([TOSHIBA PROSEC T/V])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X External input
Decimal + 
hexadecim
al

X(Word address)(Bit address)
Notation example: X5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

○ ○

Y External output
Decimal + 
hexadecim
al

Y(Word address)(Bit address)
Notation example: Y5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

○ ○

Z Link register relay
Decimal + 
hexadecim
al

Z(Word address)(Bit address)
Notation example: Z9990
The rightmost digit is a bit address.
• Word address (decimal): 000 to 999F
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

R*2 Internal relay
Decimal + 
hexadecim
al

R(Word address)(Bit address)
Notation example: R40950
The rightmost digit is a bit address.
• Word address (decimal): 0000 to 4095
• Bit address (hexadecimal): 0 to F

○ ○

T*3 Timer (Contact) Decimal 0 to 999 ○
○
(Not usable as 
word data)

C*3 Counter (Contact) Decimal 0 to 511 ○
○
(Not usable as 
word data)

L Link relay
Decimal + 
hexadecim
al

L(Word address)(Bit address)
Notation example: L2550
The rightmost digit is a bit address.
• Word address (decimal): 000 to 255
• Bit address (hexadecimal): 0 to F

○ ○

S Special relay
Decimal + 
hexadecim
al

S(Word address)(Bit address)
Notation example: S5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X*1 R/W -/- -/- -/- -/-

Y*1 R/W -/- -/- -/- -/-

Z R/W -/- -/- -/- -/-
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*1 To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use XW for X.

■4 Monitoring-supported word devices ([TOSHIBA PROSEC T/V])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.15 ■5 Availability of writing/reading data to/from word devices ([TOSHIBA PROSEC T/V])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The notation of device setting is different between the TOSHIBA PLC peripheral software and GOT.
For the notation of devices, refer to the following.

➟12.4.15 ■6 Notation of devices ([TOSHIBA PROSEC T/V])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The GOT reads the value from a device and then write a value to the device.

Do not change the device value with a sequence program until the GOT completes writing a value to the device.
*3 Although the device is defined as DW in the manual of TOSHIBA PLC, D or RW is used for setting as they are used for 

computer link connection.
D and RW are different names, but practically represent the same device.

*4 Extension file register is not supported.

■5 Availability of writing/reading data to/from word devices ([TOSHIBA PROSEC T/V])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

R*1 R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

L*1 R/W -/- -/- -/- -/-

S*1 R/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T*2 Timer (Current value) Decimal 0 to 999 ○ ○

C*2 Counter (Current value) Decimal 0 to 511 ○ ○

D*3 Data register Decimal 0 to 8191 ○ ○

W Link register Decimal 0 to 2047 ○ ○

F*4 File register Decimal 0 to 32767 ○ ○

XW External input Decimal 0 to 511 ○ ○

YW External output Decimal 0 to 511 ○ ○

RW*3 Internal relay Decimal 0 to 4095 ○ ○

LW Link relay Decimal 0 to 255 ○ ○

SW Special relay Decimal 0 to 511 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

T R/W R/W -/- -/-

C R/W R/W -/- -/-
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*1 The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

*2 When the mode switch on the CPU module has been set to P-RUN, writing to D0000 through D4095 is disabled.
*3 To use the device as bit data, use the bit device that has the same device name without "W".

Example) Use X for XW.

■6 Notation of devices ([TOSHIBA PROSEC T/V])
The notation of device setting is different between the TOSHIBA PLC peripheral software and GOT.

(1) Notation of bit devices ([TOSHIBA PROSEC T/V])
The conversion from the notation for the TOSHIBA PLC to that for the GOT is shown as follows.
Address notation for TOSHIBA PLC ÷ 16 = Word address (Quotient)...Bit address (Remainder)

(2) Notation of word devices ([TOSHIBA PROSEC T/V])

D*2 R/W R/W -/- R/W

W R/W R/W -/- R/W

F R/W R/W -/- R/W

XW*3 R/W R/W -/- -/-

YW*3 R/W R/W -/- -/-

RW*3 R/W R/W -/- -/-

LW*3 R/W R/W -/- -/-

SW*3 R/W R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

Example of address notation for TOSHIBA PLC Conversion Example of address notation for GOT

S8191
8191 ÷ 16 = 511...15
• Word address (decimal): 511
• Bit address (hexadecimal): F

S511 F

R65535
65535 ÷ 16 = 4095...15
• Word address (decimal): 4095
• Bit address (hexadecimal): F

R4095 F

Data type Example of address notation for TOSHIBA PLC Example of address notation for GOT

16 bits DW10 D10

32 bits

Integer
DD10
(Calculate the device No. in 32-bit unit)

D20

Real number
DF10
(Calculate the device No. in 32-bit unit)

D20
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12.4.16 TOSHIBA equipment ([TOSHIBA Unified Controller nv])

Not available to GT25-W, GT2505-V, and GT25HS-V.

■1 Device setting dialog ([TOSHIBA Unified Controller nv])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

■2 Monitoring-supported bit devices ([TOSHIBA Unified Controller nv])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([TOSHIBA Unified Controller nv])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([TOSHIBA Unified Controller nv])

➟■3 Availability of writing/reading data to/from bit devices ([TOSHIBA Unified Controller nv])

Specifications of word devices
➟■4 Monitoring-supported word devices ([TOSHIBA Unified Controller nv])

➟■5 Availability of writing/reading data to/from word devices ([TOSHIBA Unified Controller nv])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

X000000

Device name
Device number
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➟12.4.16 ■3 Availability of writing/reading data to/from bit devices ([TOSHIBA Unified Controller nv])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([TOSHIBA Unified Controller nv])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use XW for X.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X External output
Decimal + 
hexadecim
al

X(Word address)(Bit address)
Notation example: X163830
The rightmost digit is a bit address.
• Word address (decimal): 00000 to 16383
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Y External input
Decimal + 
hexadecim
al

Y(Word address)(Bit address)
Notation example: Y163830
The rightmost digit is a bit address.
• Word address (decimal): 00000 to 16383
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

R Internal relay
Decimal + 
hexadecim
al

R(Word address)(Bit address)
Notation example: R81910
The rightmost digit is a bit address.
• Word address (decimal): 0000 to 8191
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

I Input variable
Decimal + 
hexadecim
al

I(Word address)(Bit address)
Notation example: I163830
The rightmost digit is a bit address.
• Word address (decimal): 00000 to 16383
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Q Output variable
Decimal + 
hexadecim
al

Q(Word address)(Bit address)
Notation example: Q163830
The rightmost digit is a bit address.
• Word address (decimal): 00000 to 16383
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

S Special relay
Decimal + 
hexadecim
al

S(Word address)(Bit address)
Notation example: S10230
The rightmost digit is a bit address.
• Word address (decimal): 0000 to 1023
• Bit address (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X*1 R/W -/- -/- -/- -/-

Y*1 R/W -/- -/- -/- -/-

R*1 R/W -/- -/- -/- -/-

I*1 R/W -/- -/- -/- -/-

Q*1 R/W -/- -/- -/- -/-

S*1 R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([TOSHIBA Unified Controller nv])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.16 ■5 Availability of writing/reading data to/from word devices ([TOSHIBA Unified Controller nv])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([TOSHIBA Unified Controller nv])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use X for XW.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

XW External input Decimal 0 to 16383 ○
○
(Not usable as bit 
data)

YW External output Decimal 0 to 16383 ○
○
(Not usable as bit 
data)

RW Internal relay Decimal 0 to 8191 ○
○
(Not usable as bit 
data)

SW Special relay Decimal 0 to 1023 ○
○
(Not usable as bit 
data)

D Data register Decimal 0 to 8191 ○ ○

F File register Decimal 0 to 32767 ○ ○

IW Input variable Decimal 0 to 16383 ○
○
(Not usable as bit 
data)

QW Output variable Decimal 0 to 16383 ○
○
(Not usable as bit 
data)

UG User global Decimal 0 to 262143 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

XW*1 R/W R/W -/- -/-

YW*1 R/W R/W -/- -/-

RW*1 R/W R/W -/- -/-

SW*1 R/W R/W -/- -/-

D R/W R/W -/- R/W

F R/W R/W -/- R/W

IW*1 R/W R/W -/- -/-

QW*1 R/W R/W -/- -/-

UG R/W R/W -/- R/W
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12.4.17 SHIBAURA MACHINE equipment ([SHIBAURA MACHINE TCmini])

■1 Device setting dialog ([SHIBAURA MACHINE TCmini])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([SHIBAURA MACHINE TCmini])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.17 ■3 Availability of writing/reading data to/from bit devices ([SHIBAURA MACHINE TCmini])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SHIBAURA MACHINE TCmini])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SHIBAURA MACHINE TCmini])

➟■3 Availability of writing/reading data to/from bit devices ([SHIBAURA MACHINE TCmini])

Specifications of word devices
➟■4 Monitoring-supported word devices ([SHIBAURA MACHINE TCmini])

➟■5 Availability of writing/reading data to/from word devices ([SHIBAURA MACHINE TCmini])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

X000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay 1

Hexadeci
mal + octal 
+ 
hexadecim
al

X(Rack No.)(Module position)(Terminal 
No.)
Notation example: XF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Y Output relay 1

Hexadeci
mal + octal 
+ 
hexadecim
al

Y(Rack No.)(Module position)(Terminal 
No.)
Notation example: YF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

R Internal relay

Hexadeci
mal + octal 
+ 
hexadecim
al

R(Rack No.)(Module position)(Terminal 
No.)
Notation example: R77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

L Latch relay

Hexadeci
mal + octal 
+ 
hexadecim
al

L(Rack No.)(Module position)(Terminal 
No.)
Notation example: L07F
• Rack No. (hexadecimal): 0
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

S Shift relay

Hexadeci
mal + octal 
+ 
hexadecim
al

S(Rack No.)(Module position)(Terminal 
No.)
Notation example: S07F
• Rack No. (hexadecimal): 0
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

E Edge relay

Hexadeci
mal + octal 
+ 
hexadecim
al

E(Rack No.)(Module position)(Terminal 
No.)
Notation example: E77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

T Timer contact

Hexadeci
mal + octal 
+ 
hexadecim
al

T(Rack No.)(Module position)(Terminal 
No.)
Notation example: T77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

C Counter contact

Hexadeci
mal + octal 
+ 
hexadecim
al

C(Rack No.)(Module position)(Terminal 
No.)
Notation example: C77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

I Input relay 2

Hexadeci
mal + octal 
+ 
hexadecim
al

I(Rack No.)(Module position)(Terminal No.)
Notation example: IF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

O Output relay 2

Hexadeci
mal + octal 
+ 
hexadecim
al

O(Rack No.)(Module position)(Terminal 
No.)
Notation example: OF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([SHIBAURA MACHINE TCmini])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use XW for X.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

GR Extended internal relay 1

Hexadeci
mal + octal 
+ 
hexadecim
al

GR(Rack No.)(Module position)(Terminal 
No.)
Notation example: GRF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

H Extended internal relay 2

Hexadeci
mal + octal 
+ 
hexadecim
al

H(Rack No.)(Module position)(Terminal 
No.)
Notation example: HF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

J Extended internal relay 3

Hexadeci
mal + octal 
+ 
hexadecim
al

J(Rack No.)(Module position)(Terminal No.)
Notation example: JF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

K Extended internal relay 4

Hexadeci
mal + octal 
+ 
hexadecim
al

K(Rack No.)(Module position)(Terminal 
No.)
Notation example: KF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

A Special aux relay

Hexadeci
mal + octal 
+ 
hexadecim
al

A(Rack No.)(Module position)(Terminal 
No.)
Notation example: A16F
• Rack No. (hexadecimal): 0 to 1
• Module position (octal): 0 to 7 (0 to 6 when 

the rack No. is 1.)
• Terminal No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

S R/W -/- -/- -/- -/-

E R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

I R/W -/- -/- -/- -/-

O R/W -/- -/- -/- -/-

GR R/W -/- -/- -/- -/-

H R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([SHIBAURA MACHINE TCmini])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.17 ■5 Availability of writing/reading data to/from word devices ([SHIBAURA MACHINE TCmini])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

J R/W -/- -/- -/- -/-

K R/W -/- -/- -/- -/-

A R/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

P Timer/Counter current value

Hexadeci
mal + octal 
+ 
hexadecim
al

P(Rack No.)(Module position)(Register No.)
Notation example: P77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

XW Input register 1 Hexadeci
mal + octal

XW(Rack No.)(Module position)
Notation example: XWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

IW Input register 2 Hexadeci
mal + octal

IW(Rack No.)(Module position)
Notation example: IWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

YW Output register 1 Hexadeci
mal + octal

YW(Rack No.)(Module position)
Notation example: YWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

OW Output register 2 Hexadeci
mal + octal

OW(Rack No.)(Module position)
Notation example: OWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

RW Internal register Hexadeci
mal + octal

RW(Rack No.)(Module position)
Notation example: RW77
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

GW Extended internal register 1 Hexadeci
mal + octal

GW(Rack No.)(Module position)
Notation example: GWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

HW Extended internal register 2 Hexadeci
mal + octal

HW(Rack No.)(Module position)
Notation example: HWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

JW Extended internal register 3 Hexadeci
mal + octal

JW(Rack No.)(Module position)
Notation example: JWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

KW Extended internal register 4 Hexadeci
mal + octal

KW(Rack No.)(Module position)
Notation example: KWF7
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

TW Timer contact register Hexadeci
mal + octal

TW(Rack No.)(Module position)
Notation example: TW77
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

CW Counter contact register Hexadeci
mal + octal

CW(Rack No.)(Module position)
Notation example: CW77
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

SW Shift register Hexadeci
mal + octal

SW(Rack No.)(Module position)
Notation example: SW07
• Rack No. (hexadecimal): 0
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

LW Latch register Hexadeci
mal + octal

LW(Rack No.)(Module position)
Notation example: LW07
• Rack No. (hexadecimal): 0
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

EW Edge register Hexadeci
mal + octal

EW(Rack No.)(Module position)
Notation example: EW77
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7

○
○
(Not usable as bit 
data)

AW Special aux register Hexadeci
mal + octal

AW(Rack No.)(Module position)
Notation example: AW17
• Rack No. (hexadecimal): 0 to 1
• Module position (octal): 0 to 7 (0 to 6 when 

the rack No. is 1.)

○
○
(Not usable as bit 
data)

D Generic register 1

Hexadeci
mal + octal 
+ 
hexadecim
al

D(Rack No.)(Module position)(Register 
No.)
Notation example: DF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

B Generic register 2

Hexadeci
mal + octal 
+ 
hexadecim
al

B(Rack No.)(Module position)(Register No.)
Notation example: BF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

U Generic register 3

Hexadeci
mal + octal 
+ 
hexadecim
al

U(Rack No.)(Module position)(Register 
No.)
Notation example: UF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

M Generic register 4

Hexadeci
mal + octal 
+ 
hexadecim
al

M(Rack No.)(Module position)(Register 
No.)
Notation example: MF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

Q Generic register 5

Hexadeci
mal + octal 
+ 
hexadecim
al

Q(Rack No.)(Module position)(Register 
No.)
Notation example: QF7F
• Rack No. (hexadecimal): 0 to F
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

V Timer/Counter set value

Hexadeci
mal + octal 
+ 
hexadecim
al

V(Rack No.)(Module position)(Register No.)
Notation example: V77F
• Rack No. (hexadecimal): 0 to 7
• Module position (octal): 0 to 7
• Register No. (hexadecimal): 0 to F

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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■5 Availability of writing/reading data to/from word devices ([SHIBAURA MACHINE TCmini])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use X for XW.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

P R/W -/- -/- -/-

XW*1 R/W R/- -/- -/-

IW*1 R/W R/- -/- -/-

YW*1 R/W R/W -/- -/-

OW*1 R/W R/W -/- -/-

RW*1 R/W R/W -/- -/-

GW*1 R/W R/W -/- -/-

HW*1 R/W R/W -/- -/-

JW*1 R/W R/W -/- -/-

KW*1 R/W R/W -/- -/-

TW*1 R/W R/W -/- -/-

CW*1 R/W R/W -/- -/-

SW*1 R/W R/W -/- -/-

LW*1 R/W R/W -/- -/-

EW*1 R/W R/W -/- -/-

AW*1 R/W R/W -/- -/-

D R/W R/W -/- -/-

B R/W R/W -/- -/-

U R/W R/W -/- -/-

M R/W R/W -/- -/-

Q R/W R/W -/- -/-

V R/W -/- -/- -/-
12 - 576 12. APPENDICES
12.4 Device Range and Settings of Each Controller



A
PP

EN
D

IC
ES

12
12.4.18 PANASONIC equipment ([Panasonic MINAS A4])

■1 Device setting dialog ([Panasonic MINAS A4])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of STS0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [0] to [15] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([Panasonic MINAS A4])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Panasonic MINAS A4])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([Panasonic MINAS A4])

➟■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A4])

Specifications of word devices
➟■4 Monitoring-supported word devices ([Panasonic MINAS A4])

➟■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A4])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([Panasonic MINAS A4])

➟■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A4])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

STS0

Device name
Device number
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(1) Indirect specification of a station number ([Panasonic MINAS A4])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the relationship between the specified station number and the GOT data register (GD).

■2 Monitoring-supported bit devices ([Panasonic MINAS A4])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.18 ■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A4])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A4])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [15]
Setting a value outside the above range causes a timeout error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

STS Status Decimal 0 to 7 × ×

INP Input signal Decimal 0 to 31 ○ ×

OTP Output signal Decimal 0 to 47 ○ ×

AEST Absolute encoder (Status) Decimal 0 to 15 × ×

EPRW Writing of parameter to EEPROM Decimal 0 × ×

ALHC Clear of user alarm history (in 
EEPROM as well) Decimal 0 × ×

ALMC Alarm clear Decimal 0 × ×

ABSC Absolute clear Decimal 0 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

STS R/- -/- -/- -/- -/-

INP R/- -/- -/- -/- -/-

OTP R/- -/- -/- -/- -/-

AEST R/- -/- -/- -/- -/-

EPRW -/W -/- -/- -/- -/-

ALHC -/W -/- -/- -/- -/-

ALMC -/W -/- -/- -/- -/-

ABSC -/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([Panasonic MINAS A4])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.18 ■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A4])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A4])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

STCM Status (Control modes) Decimal 0 × ×

SPD Present speed Decimal 0 × ×

TRQ Present torque output Decimal 0 × ×

AEID Absolute encoder (Encoder ID) Decimal 0 × ×

AEMD Absolute encoder (Multi-turn data) Decimal 0 × ×

PRM Parameter Hexadeci
mal 0000 to 007F ○ ×

ALM Present alarm data Decimal 0 × ×

ALHI User alarm history Decimal 1 to 14 ○ ×

PRMN User parameter (MIN. value) Hexadeci
mal 0000 to 007F ○ ×

PRMX User parameter (MAX. value) Hexadeci
mal 0000 to 007F ○ ×

PRPR Attribute Hexadeci
mal 0000 to 007F ○ ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

STCM R/- -/- -/- -/-

SPD R/- -/- -/- -/-

TRQ R/- -/- -/- -/-

AEID R/- -/- -/- -/-

AEMD R/- -/- -/- -/-

PRM R/W -/- -/- -/-

ALM R/- -/- -/- -/-

ALHI R/- -/- -/- -/-

PRMN R/- -/- -/- -/-

PRMX R/- -/- -/- -/-

PRPR R/- -/- -/- -/-
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■6 Monitoring-supported double-word devices ([Panasonic MINAS A4])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.18 ■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A4])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A4])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

FBPC Feedback pulse counter Decimal 0 × ×

DVC Present deviation counter Decimal 0 × ×

AESD Absolute encoder (Single turn 
data) Decimal 0 × ×

ESA External scale deviation and sum 
of pulses Decimal 0 to 1 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

FBPC -/- R/- -/- -/-

DVC -/- R/- -/- -/-

AESD -/- R/- -/- -/-

ESA -/- R/- -/- -/-
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12.4.19 PANASONIC equipment ([Panasonic MINAS A5])

■1 Device setting dialog ([Panasonic MINAS A5])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of STS0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [0] to [31] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([Panasonic MINAS A5])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Panasonic MINAS A5])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([Panasonic MINAS A5])

➟■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A5])

Specifications of word devices
➟■4 Monitoring-supported word devices ([Panasonic MINAS A5])

➟■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A5])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([Panasonic MINAS A5])

➟■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A5])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

STS0

Device name
Device number
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(1) Indirect specification of a station number ([Panasonic MINAS A5])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the relationship between the specified station number and the GOT data register (GD).

■2 Monitoring-supported bit devices ([Panasonic MINAS A5])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.19 ■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A5])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([Panasonic MINAS A5])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [31]
Setting a value outside the above range causes a timeout error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

STS Status Decimal 0 to 7 × ×

INP Input signal Decimal 0 to 31 ○ ×

OTP Output signal Decimal 0 to 47 ○ ×

AEST Absolute encoder (Status) Decimal 0 to 15 × ×

EPRW Writing of parameter to EEPROM Decimal 0 × ×

ALHC Clear of user alarm history (in 
EEPROM as well) Decimal 0 × ×

ALMC Alarm clear Decimal 0 × ×

ABSC Absolute clear Decimal 0 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

STS R/- -/- -/- -/- -/-

INP R/- -/- -/- -/- -/-

OTP R/- -/- -/- -/- -/-

AEST R/- -/- -/- -/- -/-

EPRW -/W -/- -/- -/- -/-

ALHC -/W -/- -/- -/- -/-

ALMC -/W -/- -/- -/- -/-

ABSC -/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([Panasonic MINAS A5])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.19 ■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A5])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([Panasonic MINAS A5])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

STCM Status (Control modes) Decimal 0 × ×

SPD Present speed Decimal 0 × ×

TRQ Present torque output Decimal 0 × ×

AEID Absolute encoder (Encoder ID) Decimal 0 × ×

AEMD Absolute encoder (Multi-turn data) Decimal 0 × ×

ALM Present alarm data Decimal 0 × ×

ALMS Present alarm data (Sub number) Decimal 0 × ×

ALHI User alarm history Decimal 1 to 14 ○ ×

ALHS User alarm history (Sub number) Decimal 1 to 14 ○ ×

PRPR0 User parameter (Class.0, 
Property) Decimal 0 to 17 ○ ×

PRPR1 User parameter (Class.1, 
Property) Decimal 0 to 27 ○ ×

PRPR2 User parameter (Class.2, 
Property) Decimal 0 to 23 ○ ×

PRPR3 User parameter (Class.3, 
Property) Decimal 0 to 29 ○ ×

PRPR4 User parameter (Class.4, 
Property) Decimal 0 to 42 ○ ×

PRPR5 User parameter (Class.5, 
Property) Decimal 0 to 35 ○ ×

PRPR6 User parameter (Class.6, 
Property) Decimal 0 to 39 ○ ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

STCM R/- -/- -/- -/-

SPD R/- -/- -/- -/-

TRQ R/- -/- -/- -/-

AEID R/- -/- -/- -/-

AEMD R/- -/- -/- -/-

ALM R/- -/- -/- -/-

ALMS R/- -/- -/- -/-

ALHI R/- -/- -/- -/-

ALHS R/- -/- -/- -/-
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■6 Monitoring-supported double-word devices ([Panasonic MINAS A5])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.19 ■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A5])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

PRPR0 R/- -/- -/- -/-

PRPR1 R/- -/- -/- -/-

PRPR2 R/- -/- -/- -/-

PRPR3 R/- -/- -/- -/-

PRPR4 R/- -/- -/- -/-

PRPR5 R/- -/- -/- -/-

PRPR6 R/- -/- -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PRM0 Parameter (Class.0) Decimal 0 to 17 × ×

PRM1 Parameter (Class.1) Decimal 0 to 27 × ×

PRM2 Parameter (Class.2) Decimal 0 to 23 × ×

PRM3 Parameter (Class.3) Decimal 0 to 29 × ×

PRM4 Parameter (Class.4) Decimal 0 to 42 × ×

PRM5 Parameter (Class.5) Decimal 0 to 35 × ×

PRM6 Parameter (Class.6) Decimal 0 to 39 × ×

PRMN0 User parameter (Class.0, 
MIN.value) Decimal 0 to 17 × ×

PRMN1 User parameter (Class.1, 
MIN.value) Decimal 0 to 27 × ×

PRMN2 User parameter (Class.2, 
MIN.value) Decimal 0 to 23 × ×

PRMN3 User parameter (Class.3, 
MIN.value) Decimal 0 to 29 × ×

PRMN4 User parameter (Class.4, 
MIN.value) Decimal 0 to 42 × ×

PRMN5 User parameter (Class.5, 
MIN.value) Decimal 0 to 35 × ×

PRMN6 User parameter (Class.6, 
MIN.value) Decimal 0 to 39 × ×

PRMX0 User parameter (Class.0, 
MAX.value) Decimal 0 to 17 × ×

PRMX1 User parameter (Class.1, 
MAX.value) Decimal 0 to 27 × ×

PRMX2 User parameter (Class.2, 
MAX.value) Decimal 0 to 23 × ×

PRMX3 User parameter (Class.3, 
MAX.value) Decimal 0 to 29 × ×

PRMX4 User parameter (Class.4, 
MAX.value) Decimal 0 to 42 × ×

PRMX5 User parameter (Class.5, 
MAX.value) Decimal 0 to 35 × ×

PRMX6 User parameter (Class.6, 
MAX.value) Decimal 0 to 39 × ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([Panasonic MINAS A5])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

FBPC Feedback pulse counter Decimal 0 × ×

DVC Present deviation counter Decimal 0 × ×

AESD Absolute encoder (Single turn 
data) Decimal 0 × ×

ESA External scale deviation and sum 
of pulses Decimal 0 to 1 × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

PRM0 -/- R/W -/- -/-

PRM1 -/- R/W -/- -/-

PRM2 -/- R/W -/- -/-

PRM3 -/- R/W -/- -/-

PRM4 -/- R/W -/- -/-

PRM5 -/- R/W -/- -/-

PRM6 -/- R/W -/- -/-

PRMN0 -/- R/- -/- -/-

PRMN1 -/- R/- -/- -/-

PRMN2 -/- R/- -/- -/-

PRMN3 -/- R/- -/- -/-

PRMN4 -/- R/- -/- -/-

PRMN5 -/- R/- -/- -/-

PRMN6 -/- R/- -/- -/-

PRMX0 -/- R/- -/- -/-

PRMX1 -/- R/- -/- -/-

PRMX2 -/- R/- -/- -/-

PRMX3 -/- R/- -/- -/-

PRMX4 -/- R/- -/- -/-

PRMX5 -/- R/- -/- -/-

PRMX6 -/- R/- -/- -/-

FBPC -/- R/- -/- -/-

DVC -/- R/- -/- -/-

AESD -/- R/- -/- -/-

ESA -/- R/- -/- -/-
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12.4.20 PANASONIC IDS equipment ([Panasonic MEWNET-FP])

■1 Device setting dialog ([Panasonic MEWNET-FP])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([Panasonic MEWNET-FP])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.20 ■3 Availability of writing/reading data to/from bit devices ([Panasonic MEWNET-FP])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Panasonic MEWNET-FP])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([Panasonic MEWNET-FP])

➟■3 Availability of writing/reading data to/from bit devices ([Panasonic MEWNET-FP])

Specifications of word devices
➟■4 Monitoring-supported word devices ([Panasonic MEWNET-FP])

➟■5 Availability of writing/reading data to/from word devices ([Panasonic MEWNET-FP])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

X0000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Only those devices that have been assigned to I/O contacts by peripheral software can be used.
*3 The number of timer and counter devices differs depending on the head numbers of the counter set by the value of the 

system register (No. 5).

■3 Availability of writing/reading data to/from bit devices ([Panasonic MEWNET-FP])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X*2 Input relay
Decimal + 
hexadecim
al

X(Word address)(Bit address)
Notation example: X5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

○ ○

Y*2 Output relay
Decimal + 
hexadecim
al

Y(Word address)(Bit address)
Notation example: Y5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

○ ○

L Link relay
Decimal + 
hexadecim
al

L(Word address)(Bit address)
Notation example: L6390
The rightmost digit is a bit address.
• Word address (decimal): 000 to 639
• Bit address (hexadecimal): 0 to F

○ ○

R

Internal relay

Decimal + 
hexadecim
al

R(Word address)(Bit address)
Notation example: R8860
The rightmost digit is a bit address.
• Word address (decimal): 000 to 886
• Bit address (hexadecimal): 0 to F

○ ○

Special relay

R(Word address)(Bit address)
Notation example: R9510
The rightmost digit is a bit address.
• Word address (decimal): 900 to 951
• Bit address (hexadecimal): 0 to F

T*3 Timer contact Decimal 0000 to 3071 ○
○
(Not usable as 
word data)

C*3 Counter contact Decimal 0000 to 3071 ○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/- -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

R (internal relay) R/W -/- -/- -/- -/-

R (special relay) R/- -/- -/- -/- -/-

T R/- -/- -/- -/- -/-

C R/- -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([Panasonic MEWNET-FP])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.20 ■5 Availability of writing/reading data to/from word devices ([Panasonic MEWNET-FP])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The number of timer and counter devices differs depending on the head numbers of the counter set by the value of the 

system register (No. 5).
*3 When FP2SH is used, only one bank of 32765 × 3 banks can be monitored.

■5 Availability of writing/reading data to/from word devices ([Panasonic MEWNET-FP])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

EV*2 Timer/Counter (Elapsed value) Decimal 0 to 3071 ○ ○

DT Data register Decimal
0 to 65532
90000 to 90999

○ ○

LD Link register Decimal 0 to 8447 ○ ○

FL*3 File register Decimal 0 to 32764 ○ ○

WX Input relay Decimal 000 to 511 ○ ○

WY Output relay Decimal 000 to 511 ○ ○

WR
Internal relay

Decimal
000 to 886

○ ○
Special relay 900 to 951

WL Link relay Decimal 000 to 639 ○ ○

SV*2 Timer/Counter set value Decimal 0 to 3071 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

EV R/W R/W -/- R/W

DT R/W R/W -/- R/W

LD R/W R/W -/- R/W

FL R/W R/W -/- R/W

WX R/- R/- -/- -/-

WY R/W R/W -/- -/-

WR (internal relay) R/W R/W -/- -/-

WR (special relay) R/- R/- -/- -/-

WL R/W R/W -/- -/-

SV R/W R/W -/- R/W
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12.4.21 PANASONIC IDS equipment ([Panasonic FP7])

■1 Device setting dialog ([Panasonic FP7])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([Panasonic FP7])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.21 ■3 Availability of writing/reading data to/from bit devices ([Panasonic FP7])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Panasonic FP7])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([Panasonic FP7])

➟■3 Availability of writing/reading data to/from bit devices ([Panasonic FP7])

Specifications of word devices
➟■4 Monitoring-supported word devices ([Panasonic FP7])

➟■5 Availability of writing/reading data to/from word devices ([Panasonic FP7])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([Panasonic FP7])

➟■7 Availability of writing/reading data to/from double-word devices ([Panasonic FP7])
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2) 3)

1)

X0000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay
Decimal + 
hexadecim
al

X(Word address)(Bit address)
Notation example: X5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

× ×

Y Output relay
Decimal + 
hexadecim
al

Y(Word address)(Bit address)
Notation example: Y5110
The rightmost digit is a bit address.
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

× ×

L Link relay
Decimal + 
hexadecim
al

L(Word address)(Bit address)
Notation example: L10230
The rightmost digit is a bit address.
• Word address (decimal): 0000 to 1023
• Bit address (hexadecimal): 0 to F

× ×

R Internal relay
Decimal + 
hexadecim
al

R(Word address)(Bit address)
Notation example: R20470
The rightmost digit is a bit address.
• Word address (decimal): 0000 to 2047
• Bit address (hexadecimal): 0 to F

× ×

T Timer contact Decimal 0000 to 4095 × ×

C Counter contact Decimal 0000 to 1023 × ×

SR System relay
Decimal + 
hexadecim
al

SR(Word address)(Bit address)
Notation example: SR2230
The rightmost digit is a bit address.
• Word address (decimal): 000 to 223
• Bit address (hexadecimal): 0 to F

× ×

P Pulse relay
Decimal + 
hexadecim
al

P(Word address)(Bit address)
Notation example: P2550
The rightmost digit is a bit address.
• Word address (decimal): 000 to 255
• Bit address (hexadecimal): 0 to F

× ×

E Error alarm relay Decimal 0000 to 4095 × ×

IN Direct input
Decimal + 
hexadecim
al

S(Slot No.):IN(Word address)(Bit address)
Notation example: S64:IN620
The rightmost digit is a bit address.
• Slot No. (decimal): 1 to 64
• Word address (decimal): 00 to 62
• Bit address (hexadecimal): 0 to F

× ×

OT Direct output
Decimal + 
hexadecim
al

S(Slot No.):OT(Word address)(Bit address)
Notation example: S64:OT620
The rightmost digit is a bit address.
• Slot No. (decimal): 1 to 64
• Word address (decimal): 00 to 62
• Bit address (hexadecimal): 0 to F

× ×

_X Input relay
Decimal + 
hexadecim
al

PB(Program block No.)_X(Word 
address)(Bit address)
Notation example: PB468_X5110
The rightmost digit is a bit address.
• Program block No. (decimal): 1 to 468
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

× ×
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([Panasonic FP7])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

_Y Output relay
Decimal + 
hexadecim
al

PB(Program block No.)_Y(Word 
address)(Bit address)
Notation example: PB468_Y5110
The rightmost digit is a bit address.
• Program block No. (decimal): 1 to 468
• Word address (decimal): 000 to 511
• Bit address (hexadecimal): 0 to F

× ×

_L Link relay
Decimal + 
hexadecim
al

PB(Program block No.)_L(Word 
address)(Bit address)
Notation example: PB468_L10230
The rightmost digit is a bit address.
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 1023
• Bit address (hexadecimal): 0 to F

× ×

_R Internal relay
Decimal + 
hexadecim
al

PB(Program block No.)_R(Word 
address)(Bit address)
Notation example: PB468_R20470
The rightmost digit is a bit address.
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 2047
• Bit address (hexadecimal): 0 to F

× ×

_T Timer contact Decimal

PB(Program block No.)_T(Word address)
Notation example: PB468_T4095
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 4095

× ×

_C Counter contact Decimal

PB(Program block No.)_C(Word address)
Notation example: PB468_C1023
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 1023

× ×

_P Pulse relay
Decimal + 
hexadecim
al

PB(Program block No.)_P(Word 
address)(Bit address)
Notation example: PB468_P2550
The rightmost digit is a bit address.
• Program block No. (decimal): 1 to 468
• Word address (decimal): 000 to 255
• Bit address (hexadecimal): 0 to F

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

T R/- -/- -/- -/- -/-

C R/- -/- -/- -/- -/-

SR R/- -/- -/- -/- -/-

P R/- -/- -/- -/- -/-

E R/- -/- -/- -/- -/-

IN R/- -/- -/- -/- -/-
12. APPENDICES
12.4 Device Range and Settings of Each Controller

12 - 591



■4 Monitoring-supported word devices ([Panasonic FP7])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.21 ■5 Availability of writing/reading data to/from word devices ([Panasonic FP7])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

OT R/W -/- -/- -/- -/-

_X R/W -/- -/- -/- -/-

_Y R/W -/- -/- -/- -/-

_L R/W -/- -/- -/- -/-

_R R/W -/- -/- -/- -/-

_T R/- -/- -/- -/- -/-

_C R/- -/- -/- -/- -/-

_P R/- -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DT Data register Decimal 0 to 999423 ○ ○

LD Link register Decimal 0 to 16383 ○ ○

WX Input relay Decimal 000 to 511 ○
○
(Not usable as bit 
data)

WY Output relay Decimal 000 to 511 ○
○
(Not usable as bit 
data)

WR Internal relay Decimal 0000 to 2047 ○
○
(Not usable as bit 
data)

WL Link relay Decimal 0000 to 1023 ○
○
(Not usable as bit 
data)

WI Direct input Decimal

S(Slot No.):WI(Word address)
Notation example: S64:WI62
• Slot No. (decimal): 1 to 64
• Word address (decimal): 00 to 62

× ×

WO Direct output Decimal

S(Slot No.):WO(Word address)
Notation example: S64:WO62
• Slot No. (decimal): 1 to 64
• Word address (decimal): 00 to 62

○
○
(Not usable as bit 
data)

WS System relay Decimal 0 to 223 × ×

UM Unit memory Decimal

S(Slot No.):UM(Word address)
Notation example: S64:UM524287
• Slot No. (decimal): 1 to 64
• Word address (decimal): 0 to 524287

○ ○

SD System data register Decimal 0 to 255 × ×

_DT Data register Decimal

PB(Program block No.)_DT(Word address)
Notation example: PB468_DT999423
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 999423

○ ○

_LD Link register Decimal

PB(Program block No.)_LD(Word address)
Notation example: PB468_LD16383
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 16383

○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([Panasonic FP7])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

_WX Input relay Decimal

PB(Program block No.)_WX(Word address)
Notation example: PB468_WX511
• Program block No. (decimal): 1 to 468
• Word address (decimal): 000 to 511

○
○
(Not usable as bit 
data)

_WY Output relay Decimal

PB(Program block No.)_WY(Word address)
Notation example: PB468_WY511
• Program block No. (decimal): 1 to 468
• Word address (decimal): 000 to 511

○
○
(Not usable as bit 
data)

_WR Internal relay Decimal

PB(Program block No.)_WR(Word 
address)
Notation example: PB468_WR2047
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 2047

○
○
(Not usable as bit 
data)

_WL Link relay Decimal

PB(Program block No.)_WL(Word address)
Notation example: PB468_WL1023
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0000 to 1023

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

DT R/W R/W -/- R/W

LD R/W R/W -/- R/W

WX R/W R/W -/- -/-

WY R/W R/W -/- -/-

WR R/W R/W -/- -/-

WL R/W R/W -/- -/-

WI R/- R/- -/- -/-

WO R/W R/W -/- -/-

WS R/- R/- -/- -/-

UM R/W R/W -/- R/W

SD R/- R/- -/- -/-

_DT R/W R/W -/- R/W

_LD R/W R/W -/- R/W

_WX R/W R/W -/- -/-

_WY R/W R/W -/- -/-

_WR R/W R/W -/- -/-

_WL R/W R/W -/- -/-
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■6 Monitoring-supported double-word devices ([Panasonic FP7])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.21 ■7 Availability of writing/reading data to/from double-word devices ([Panasonic FP7])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([Panasonic FP7])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Index register Hexadeci
mal 0 to E × ×

TS Timer set value area Decimal 0 to 4095 × ×

TE Timer elapsed value area Decimal 0 to 4095 × ×

CS Counter set value area Decimal 0 to 1023 × ×

CE Counter elapsed value area Decimal 0 to 1023 × ×

_TS Timer set value area Decimal

PB(Program block No.)_TS(Word address)
Notation example: PB468_TS4095
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 4095

× ×

_TE Timer elapsed value area Decimal

PB(Program block No.)_TE(Word address)
Notation example: PB468_TE4095
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 4095

× ×

_CS Counter set value area Decimal

PB(Program block No.)_CS(Word address)
Notation example: PB468_CS1023
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 1023

× ×

_CE Counter elapsed value area Decimal

PB(Program block No.)_CE(Word address)
Notation example: PB468_CE1023
• Program block No. (decimal): 1 to 468
• Word address (decimal): 0 to 1023

× ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

I -/- R/W -/- -/-

TS -/- R/W -/- -/-

TE -/- R/W -/- -/-

CS -/- R/W -/- -/-

CE -/- R/W -/- -/-

_TS -/- R/W -/- -/-

_TE -/- R/W -/- -/-

_CS -/- R/W -/- -/-

_CE -/- R/W -/- -/-
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12.4.22 HITACHI IES equipment ([HITACHI IES EHV])

■1 Device setting dialog ([HITACHI IES EHV])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of L0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.
The setting range is [1] to [239].

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.
The setting range is [1] to [254].

Item Reference

Device setting dialog ➟■1 Device setting dialog ([HITACHI IES EHV])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([HITACHI IES EHV])

➟■3 Availability of writing/reading data to/from bit devices ([HITACHI IES EHV])

Specifications of word devices
➟■4 Monitoring-supported word devices ([HITACHI IES EHV])

➟■5 Availability of writing/reading data to/from word devices ([HITACHI IES EHV])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

L0000

Device name
Device number
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■2 Monitoring-supported bit devices ([HITACHI IES EHV])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.22 ■3 Availability of writing/reading data to/from bit devices ([HITACHI IES EHV])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X*2

External input

Decimal + 
decimal + 
hexadecim
al + 
decimal

X(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: X05A95
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

○ ○

Remote external input

Decimal + 
decimal + 
hexadecim
al + 
decimal

X(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: X19A95
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

Y*2

External output

Decimal + 
decimal + 
hexadecim
al + 
decimal

Y(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: Y05A95
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

○ ○

Remote external output

Decimal + 
decimal + 
hexadecim
al + 
decimal

Y(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: Y19A95
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

L 1st CPU link Hexadeci
mal 0000 to 3FFF ○ ○

M Data area Hexadeci
mal 00000 to 7FFFF ○ ○

TD On-delay timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)

CU Up counter Decimal 0 to 511 ○
○
(Not usable as 
word data)

L1 2nd CPU link Hexadeci
mal 0000 to 3FFF ○ ○

SS Single-shot timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)

WDT Watchdog timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)

MS Monostable timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Do not use a device range containing a device number to which I/O is not assigned.

If used, a device range error occurs during writing/reading, which results in system alarm 322.

TMR Retentive timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)

RCU Ring counter Decimal 0 to 511 ○
○
(Not usable as 
word data)

CT Up/Down counter Decimal 0 to 511 ○
○
(Not usable as 
word data)

R Bit internal output Hexadeci
mal 000 to 7BF ○

○
(Not usable as 
word data)

EX Extended external input

Decimal + 
hexadecim
al + 
hexadecim
al

EX(Unit No.)(Slot No.)(Module bit No.)
Notation example: EX5A7FF
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (hexadecimal): 000 to 7FF

○ ○

EY Extended external output

Decimal + 
hexadecim
al + 
hexadecim
al

EY(Unit No.)(Slot No.)(Module bit No.)
Notation example: EY5A7FF
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (hexadecimal): 000 to 7FF

○ ○

TDN Off-delay timer Decimal 0 to 2559 ○
○
(Not usable as 
word data)

CTU Up coil up/down counter Decimal 0 to 511 ○
○
(Not usable as 
word data)

CTD Down coil up/down counter Decimal 0 to 511 ○
○
(Not usable as 
word data)

CL Counter clear Decimal 0 to 2559 ○
○
(Not usable as 
word data)

L2 3rd CPU link Hexadeci
mal 0000 to 3FFF ○ ○

L3 4th CPU link Hexadeci
mal 0000 to 3FFF ○ ○

L4 5th CPU link Hexadeci
mal 0000 to 3FFF ○ ○

L5 6th CPU link Hexadeci
mal 0000 to 3FFF ○ ○

L6 7th CPU link Hexadeci
mal 0000 to 3FFF ○ ○

L7 8th CPU link Hexadeci
mal 0000 to 3FFF ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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■3 Availability of writing/reading data to/from bit devices ([HITACHI IES EHV])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([HITACHI IES EHV])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.22 ■5 Availability of writing/reading data to/from word devices ([HITACHI IES EHV])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

TD R/W -/- -/- -/- -/-

CU R/W -/- -/- -/- -/-

L1 R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

WDT R/W -/- -/- -/- -/-

MS R/W -/- -/- -/- -/-

TMR R/W -/- -/- -/- -/-

RCU R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

EX R/W -/- -/- -/- -/-

EY R/W -/- -/- -/- -/-

TDN R/W -/- -/- -/- -/-

CTU R/W -/- -/- -/- -/-

CTD R/W -/- -/- -/- -/-

CL R/W -/- -/- -/- -/-

L2 R/W -/- -/- -/- -/-

L3 R/W -/- -/- -/- -/-

L4 R/W -/- -/- -/- -/-

L5 R/W -/- -/- -/- -/-

L6 R/W -/- -/- -/- -/-

L7 R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TC Timer/Counter (Elapsed 
value) Decimal 0 to 2559 ○ ○

WR Word internal output Hexadeci
mal 0000 to EFFF ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

WX*2

External input

Decimal + 
decimal + 
hexadecim
al + 
decimal

WX(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: WX05A7
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

Remote external input

Decimal + 
decimal + 
hexadecim
al + 
decimal

WX(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: WX19A7
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

WY*2

External output

Decimal + 
decimal + 
hexadecim
al + 
decimal

WY(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: WY05A7
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

Remote external output

Decimal + 
decimal + 
hexadecim
al + 
decimal

WY(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: WY19A7
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

WL1 2nd CPU link Hexadeci
mal 000 to 3FF ○ ○

WL 1st CPU link Hexadeci
mal 000 to 3FF ○ ○

WM Data area Hexadeci
mal 0000 to 7FFF ○ ○

WEX Extended external input

Decimal + 
hexadecim
al + 
hexadecim
al

WEX(Unit No.)(Slot No.)(Module bit No.)
Notation example: WEX5A7F
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (hexadecimal): 00 to 7F

○ ○

WEY Extended external output

Decimal + 
hexadecim
al + 
hexadecim
al

WEY(Unit No.)(Slot No.)(Module bit No.)
Notation example: WEY5A7F
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (hexadecimal): 00 to 7F

○ ○

WN Internal output Hexadeci
mal 00000 to 1FFFF ○ ○

WL2 3rd CPU link Hexadeci
mal 000 to 3FF ○ ○

WL3 4th CPU link Hexadeci
mal 000 to 3FF ○ ○

WL4 5th CPU link Hexadeci
mal 000 to 3FF ○ ○

WL5 6th CPU link Hexadeci
mal 000 to 3FF ○ ○

WL6 7th CPU link Hexadeci
mal 000 to 3FF ○ ○

WL7 8th CPU link Hexadeci
mal 000 to 3FF ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*2 Do not use a device range containing a device number to which I/O is not assigned.
If used, a device range error occurs during writing/reading, which results in system alarm 322.

■5 Availability of writing/reading data to/from word devices ([HITACHI IES EHV])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TC R/W R/W -/- -/-

WR R/W R/W -/- R/W

WX R/W R/W -/- -/-

WY R/W R/W -/- -/-

WL1 R/W R/W -/- -/-

WL R/W R/W -/- -/-

WM R/W R/W -/- -/-

WEX R/W R/W -/- -/-

WEY R/W R/W -/- -/-

WN R/W R/W -/- R/W

WL2 R/W R/W -/- -/-

WL3 R/W R/W -/- -/-

WL4 R/W R/W -/- -/-

WL5 R/W R/W -/- -/-

WL6 R/W R/W -/- -/-

WL7 R/W R/W -/- -/-
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12.4.23 HITACHI IES equipment ([HITACHI IES HIDIC H])

■1 Device setting dialog ([HITACHI IES HIDIC H])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of L0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([HITACHI IES HIDIC H])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([HITACHI IES HIDIC H])

➟■3 Availability of writing/reading data to/from bit devices ([HITACHI IES HIDIC H])

Specifications of word devices
➟■4 Monitoring-supported word devices ([HITACHI IES HIDIC H])

➟■5 Availability of writing/reading data to/from word devices ([HITACHI IES HIDIC H])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

L0000

Device name
Device number
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■2 Monitoring-supported bit devices ([HITACHI IES HIDIC H])
The following table shows monitoring-supported bit devices.
Do not set device outside the range.
If the set device is outside the range, the object set by the device within the range cannot be displayed.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.23 ■3 Availability of writing/reading data to/from bit devices ([HITACHI IES HIDIC H])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name Device No. 
representation Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X*2

External input

Decimal + 
decimal + 
hexadecimal + 
decimal

X(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: X05A95
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

○ ○

Remote external input

Decimal + 
decimal + 
decimal + 
decimal

X(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: X19995
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (decimal): 0 to 9
• Module bit No. (decimal): 00 to 95

Y*2

External output

Decimal + 
decimal + 
hexadecimal + 
decimal

Y(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: Y05A95
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 00 to 95

○ ○

Remote external output

Decimal + 
decimal + 
decimal + 
decimal

Y(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: Y19995
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (decimal): 0 to 9
• Module bit No. (decimal): 00 to 95

L 1st CPU link Hexadecimal 0000 to 3FFF ○ ○

M Data area Hexadecimal 0000 to 3FFF ○ ○

TD*3 On-delay timer Decimal 0 to 1023 ○
○
(Not usable as 
word data)

CU*3 Up counter Decimal 0 to 2047 ○
○
(Not usable as 
word data)

L1 2nd CPU link Hexadecimal 0000 to 3FFF ○ ○

SS*3 Single-shot timer Decimal 0 to 1023 ○
○
(Not usable as 
word data)

WDT*3 Watchdog timer Decimal 0 to 1023 ○
○
(Not usable as 
word data)

MS*3 Monostable timer Decimal 0 to 1023 ○
○
(Not usable as 
word data)

TMR*3 Retentive timer Decimal 0 to 1023 ○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Do not use a device range containing a device number to which I/O is not assigned.

Writing/reading is not performed normally.
*3 The same number cannot be used repeatedly.

■3 Availability of writing/reading data to/from bit devices ([HITACHI IES HIDIC H])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

RCU*3 Ring counter Decimal 0 to 2047 ○
○
(Not usable as 
word data)

CT*3 Up/Down counter Decimal 0 to 2047 ○
○
(Not usable as 
word data)

R Bit internal output Hexadecimal 000 to 7BF ○
○
(Not usable as 
word data)

DIF Rising edge detection Decimal 0 to 511 ○
○
(Not usable as 
word data)

DFN Falling edge detection Decimal 0 to 511 ○
○
(Not usable as 
word data)

Device name Device No. 
representation Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

TD R/W -/- -/- -/- -/-

CU R/W -/- -/- -/- -/-

L1 R/W -/- -/- -/- -/-

SS R/W -/- -/- -/- -/-

WDT R/W -/- -/- -/- -/-

MS R/W -/- -/- -/- -/-

TMR R/W -/- -/- -/- -/-

RCU R/W -/- -/- -/- -/-

CT R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

DIF R/W -/- -/- -/- -/-

DFN R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([HITACHI IES HIDIC H])
The following table shows monitoring-supported word devices.
Do not set device outside the range.
If the set device is outside the range, the object set by the device within the range cannot be displayed.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.23 ■5 Availability of writing/reading data to/from word devices ([HITACHI IES HIDIC H])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The same number cannot be used repeatedly.
*3 Do not use a device range containing a device number to which I/O is not assigned.

Writing/reading is not performed normally.

Device name Device No. 
representation Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TC*2 Timer/Counter (Elapsed 
value) Decimal 0000 to 2047 ○ ○

WR Word internal output Hexadecimal 0000 to C3FF ○ ○

WX*3

External input

Decimal + 
decimal + 
hexadecimal + 
decimal

WX(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: WX05A7
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

Remote external input

Decimal + 
decimal + 
decimal + 
decimal

WX(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: WX1997
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (decimal): 0 to 9
• Module bit No. (decimal): 0 to 7

○ ○

WY*3

External output

Decimal + 
decimal + 
hexadecimal + 
decimal

WY(Remote No.)(Unit No.)(Slot No.)(Module bit 
No.)
Notation example: WY05A7
• Remote No. (decimal): 0
• Unit No. (decimal): 0 to 5
• Slot No. (hexadecimal): 0 to A
• Module bit No. (decimal): 0 to 7

○ ○

Remote external output

Decimal + 
decimal + 
decimal + 
decimal

WY(Remote No.)(Remote slave station)(Slot 
No.)(Module bit No.)
Notation example: WY1997
• Remote No. (Remote master station) 

(decimal): 1 to 4
• Remote slave station (decimal): 0 to 9
• Slot No. (decimal): 0 to 9
• Module bit No. (decimal): 0 to 7

○ ○

WL1 2nd CPU link Hexadecimal 000 to 3FF ○ ○

WL 1st CPU link Hexadecimal 000 to 3FF ○ ○

WM Data area Hexadecimal 000 to 3FF ○ ○
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■5 Availability of writing/reading data to/from word devices ([HITACHI IES HIDIC H])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TC R/W R/W -/- R/W

WR R/W R/W -/- R/W

WX R/W R/W -/- -/-

WY R/W R/W -/- -/-

WL1 R/W R/W -/- -/-

WL R/W R/W -/- -/-

WM R/W R/W -/- -/-
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12.4.24 HITACHI equipment ([HITACHI S10VE])

■1 Device setting dialog ([HITACHI S10VE])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([HITACHI S10VE])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([HITACHI S10VE])

➟■3 Availability of writing/reading data to/from bit devices ([HITACHI S10VE])

Specifications of word devices
➟■4 Monitoring-supported word devices ([HITACHI S10VE])

➟■5 Availability of writing/reading data to/from word devices ([HITACHI S10VE])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([HITACHI S10VE])

➟■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10VE])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

X0000

Device name
Device number
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■2 Monitoring-supported bit devices ([HITACHI S10VE])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.24 ■3 Availability of writing/reading data to/from bit devices ([HITACHI S10VE])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X External input Hexadeci
mal

X(Address)(Bit position)
Notation example: XFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Y External output Hexadeci
mal

Y(Address)(Bit position)
Notation example: YFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

GL*2 Global link register Hexadeci
mal

GL(Address)(Bit position)
Notation example: GLFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

R Internal register Hexadeci
mal

R(Address)(Bit position)
Notation example: RFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

K Keep relay Hexadeci
mal

K(Address)(Bit position)
Notation example: KFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

E Event register Hexadeci
mal

E(Address)(Bit position)
Notation example: EFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

T On-delay timer Hexadeci
mal

T(Address)(Bit position)
Notation example: T7F0
• Address (word unit) (hexadecimal): 00 to 

7F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

C Up-down counter Hexadeci
mal

C(Address)(Bit position)
Notation example: CF0
• Address (word unit) (hexadecimal): 0 to F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

U One-shot timer Hexadeci
mal

U(Address)(Bit position)
Notation example: U0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

M Extended internal register Hexadeci
mal

M(Address)(Bit position)
Notation example: MFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

A Extended internal register Hexadeci
mal

A(Address)(Bit position)
Notation example: AFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)
12. APPENDICES
12.4 Device Range and Settings of Each Controller

12 - 607



*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

S System register Hexadeci
mal

S(Address)(Bit position)
Notation example: SBFF0
• Address (word unit) (hexadecimal): 000 to 

BFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

J Transfer register Hexadeci
mal

J(Address)(Bit position)
Notation example: JFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Q Receive register Hexadeci
mal

Q(Address)(Bit position)
Notation example: QFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

LB Extended internal register Hexadeci
mal

LB(Address)(Bit position)
Notation example: LBFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

LR Converter-specific internal 
register

Hexadeci
mal

LR(Address)(Bit position)
Notation example: LR0FF0
• Address (word unit) (hexadecimal): 000 to 

0FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

LV Converter-specific edge contact 
register

Hexadeci
mal

LV(Address)(Bit position)
Notation example: LV0FF0
• Address (word unit) (hexadecimal): 000 to 

0FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

P Process register Hexadeci
mal

P(Address)(Bit position)
Notation example: P080
• Address (word unit) (hexadecimal): 00 to 

08
• Bit position (hexadecimal): 0 to F (Set 1 

when the address is 00. Set 0 when the 
address is 08.)

○
○
(Not usable as 
word data)

V Edge contact Hexadeci
mal

V(Address)(Bit position)
Notation example: VFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

CU Up-down counter (up counter) Hexadeci
mal 00 to FF ○

○
(Not usable as 
word data)

CD Up-down counter (down counter) Hexadeci
mal 00 to FF ○

○
(Not usable as 
word data)

CR Up-down counter (reset) Hexadeci
mal 00 to FF ○

○
(Not usable as 
word data)

NM Nesting coil (master control) Hexadeci
mal 00 to FF ○

○
(Not usable as 
word data)

NZ Nesting coil (zone control) Hexadeci
mal 00 to FF ○

○
(Not usable as 
word data)

N Nesting coil Hexadeci
mal

N(Address)(Bit position)
Notation example: NF0
• Address (word unit) (hexadecimal): 0 to F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*2 The global link register (GL) corresponds to the global link register (G) of the PLU CPU.

■3 Availability of writing/reading data to/from bit devices ([HITACHI S10VE])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([HITACHI S10VE])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.24 ■5 Availability of writing/reading data to/from word devices ([HITACHI S10VE])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

GL R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

K R/W -/- -/- -/- -/-

E R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

U R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

A R/W -/- -/- -/- -/-

S R/- -/- -/- -/- -/-

J R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-

LB R/W -/- -/- -/- -/-

LR R/W -/- -/- -/- -/-

LV R/W -/- -/- -/- -/-

P R/W -/- -/- -/- -/-

V R/W -/- -/- -/- -/-

CU R/W -/- -/- -/- -/-

CD R/W -/- -/- -/- -/-

CR R/W -/- -/- -/- -/-

NM R/W -/- -/- -/- -/-

NZ R/W -/- -/- -/- -/-

N R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TC On-delay timer (count value) Hexadeci
mal 000 to 1FF ○

○
(Not usable as bit 
data)

CC Up-down counter (count value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)
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UC One-shot timer (count value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)

DW*2 Function data register Hexadeci
mal 000 to FFF ○ ○

AW Extension internal register Hexadeci
mal

AW(Address)(Bit position)
Notation example: AWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

SW System register Hexadeci
mal

SW(Address)(Bit position)
Notation example: SWBFF0
• Address (word unit) (hexadecimal): 000 to 

BFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

JW Transfer register Hexadeci
mal

JW(Address)(Bit position)
Notation example: JWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

QW Receive register Hexadeci
mal

QW(Address)(Bit position)
Notation example: QWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

TS On-delay timer (set value) Hexadeci
mal 000 to 1FF ○

○
(Not usable as bit 
data)

US One-shot timer (set value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)

CS Up-down counter (set value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)

FW*2 Function work register Hexadeci
mal 000 to BFF ○ ○

LWW*2 Extension function work register Hexadeci
mal 0000 to FFFF ○ ○

LXW*2 Backup work register Hexadeci
mal 0000 to 3FFF ○ ○

XW External input Hexadeci
mal

XW(Address)(Bit position)
Notation example: XWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

YW External output Hexadeci
mal

YW(Address)(Bit position)
Notation example: YWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

RW Internal register Hexadeci
mal

RW(Address)(Bit position)
Notation example: RWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

MW Extension internal register Hexadeci
mal

MW(Address)(Bit position)
Notation example: MWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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KW Keep relay Hexadeci
mal

KW(Address)(Bit position)
Notation example: KWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

TW On-delay timer Hexadeci
mal

TW(Address)(Bit position)
Notation example: TW7F0
• Address (word unit) (hexadecimal): 00 to 

7F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

UW One-shot timer Hexadeci
mal

UW(Address)(Bit position)
Notation example: UW0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

CW Up-down counter Hexadeci
mal

CW(Address)(Bit position)
Notation example: CW0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

GW Global link register Hexadeci
mal

GW(Address)(Bit position)
Notation example: GWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

EW Event register Hexadeci
mal

EW(Address)(Bit position)
Notation example: EWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

NW Nesting coil Hexadeci
mal

NW(Address)(Bit position)
Notation example: NW0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

PW Process register Hexadeci
mal

PW(Address)(Bit position)
Notation example: PW080
• Address (word unit) (hexadecimal): 00 to 

08
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

IW I/O input register Hexadeci
mal 000 to FFF ○

○
(Not usable as bit 
data)

OW I/O output register Hexadeci
mal 000 to FFF ○

○
(Not usable as bit 
data)

BW Function data register Hexadeci
mal 000 to 1FE ○

○
(Not usable as bit 
data)

LBW Extension internal register Hexadeci
mal

LBW(Address)(Bit position)
Notation example: LBWFFF0
• Address (word unit) (hexadecimal): 000 to 

FFF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

LRW Converter-specific internal 
register

Hexadeci
mal

LRW(Address)(Bit position)
Notation example: LRW0FF0
• Address (word unit) (hexadecimal): 000 to 

0FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When it is used with bit specification of word device, the offset function cannot be used.

■5 Availability of writing/reading data to/from word devices ([HITACHI S10VE])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

LVW Converter-specific edge contact 
register

Hexadeci
mal

LVW(Address)(Bit position)
Notation example: LVW0FF0
• Address (word unit) (hexadecimal): 000 to 

0FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

VW Edge contact Hexadeci
mal

VW(Address)(Bit position)
Notation example: VWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TC R/W -/- -/- -/-

CC R/W -/- -/- -/-

UC R/W -/- -/- -/-

DW*1 R/W R/W -/- R/W

AW R/W R/W -/- -/-

SW R/- R/- -/- -/-

JW R/W R/W -/- -/-

QW R/W R/W -/- -/-

TS R/W -/- -/- -/-

US R/W -/- -/- -/-

CS R/W -/- -/- -/-

FW*1 R/W R/W -/- R/W

LWW*1 R/W R/W -/- R/W

LXW*1 R/W R/W -/- R/W

XW R/W R/W -/- -/-

YW R/W R/W -/- -/-

RW R/W R/W -/- -/-

MW R/W R/W -/- -/-

KW R/W R/W -/- -/-

TW R/W R/W -/- -/-

UW R/W R/W -/- -/-

CW R/W R/W -/- -/-

GW R/W R/W -/- -/-

EW R/W R/W -/- -/-

NW R/W R/W -/- -/-

PW R/W R/W -/- -/-

IW R/W R/W -/- -/-

OW R/W R/W -/- -/-
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*1 When bit specification of word device is performed, the uppermost bit is b0 and the lowermost bit is b15.

■6 Monitoring-supported double-word devices ([HITACHI S10VE])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.24 ■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10VE])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

BW R/W R/W -/- -/-

LBW R/W R/W -/- -/-

LRW R/W R/W -/- -/-

LVW R/W R/W -/- -/-

VW R/W R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

b0 b1 .......... b14 b15
Higher Lower

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LLL Long-word work register Hexadeci
mal 0000 to 1FFF × ×

LML Backup long-word work register Hexadeci
mal 0000 to 1FFF × ×

LF Floating-point work register Hexadeci
mal 0000 to 1FFF × ×

LG Backup single-precision floating-
point work register

Hexadeci
mal 0000 to 1FFF × ×

DL Function data register Hexadeci
mal 000 to FFE × ×

AL Extension internal register Hexadeci
mal

AL(Address)(Bit position)
Notation example: ALFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

SL System register Hexadeci
mal

SL(Address)(Bit position)
Notation example: SLBFE0
• Address (word unit) (hexadecimal): 000 to 

BFE
• Bit position (hexadecimal): 0

× ×

JL Transfer register Hexadeci
mal

JL(Address)(Bit position)
Notation example: JLFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

QL Receive register Hexadeci
mal

QL(Address)(Bit position)
Notation example: QLFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

FL Function work register Hexadeci
mal 000 to BFE × ×

LWL Extension function work register Hexadeci
mal 0000 to FFFE × ×

LXL Backup work register Hexadeci
mal 0000 to 3FFE × ×
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XL External input Hexadeci
mal

XL(Address)(Bit position)
Notation example: XLFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

YL External output Hexadeci
mal

YL(Address)(Bit position)
Notation example: YLFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

RL Internal register Hexadeci
mal

RL(Address)(Bit position)
Notation example: RLFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

ML Extension internal register Hexadeci
mal

ML(Address)(Bit position)
Notation example: MLFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

KL Keep relay Hexadeci
mal

KL(Address)(Bit position)
Notation example: KLFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

TL On-delay timer Hexadeci
mal

TL(Address)(Bit position)
Notation example: TL7E0
• Address (word unit) (hexadecimal): 00 to 

7E
• Bit position (hexadecimal): 0

× ×

UL One-shot timer Hexadeci
mal

UL(Address)(Bit position)
Notation example: UL0E0
• Address (word unit) (hexadecimal): 00 to 

0E
• Bit position (hexadecimal): 0

× ×

CL Up-down counter Hexadeci
mal

CL(Address)(Bit position)
Notation example: CL0E0
• Address (word unit) (hexadecimal): 00 to 

0E
• Bit position (hexadecimal): 0

× ×

GWL*2 Global link register Hexadeci
mal

GWL(Address)(Bit position)
Notation example: GWLFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

EL Event register Hexadeci
mal

EL(Address)(Bit position)
Notation example: ELFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

NL Nesting coil Hexadeci
mal

NL(Address)(Bit position)
Notation example: NL0E0
• Address (word unit) (hexadecimal): 00 to 

0E
• Bit position (hexadecimal): 0

× ×

PL Process register Hexadeci
mal

PL(Address)(Bit position)
Notation example: PL060
• Address (word unit) (hexadecimal): 00 to 

06
• Bit position (hexadecimal): 0

× ×

IL I/O input register Hexadeci
mal 000 to FFE × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The global link register (GWL) corresponds to the global link register (GL) of the PLU CPU.

■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10VE])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

OL I/O output register Hexadeci
mal 000 to FFEF × ×

BL Function data register Hexadeci
mal 000 to 1FE × ×

LBL Extension internal register Hexadeci
mal

LBL(Address)(Bit position)
Notation example: LBLFFE0
• Address (word unit) (hexadecimal): 000 to 

FFE
• Bit position (hexadecimal): 0

× ×

LRL Converter-specific internal 
register

Hexadeci
mal

LRL(Address)(Bit position)
Notation example: LRL0FE0
• Address (word unit) (hexadecimal): 000 to 

0FE
• Bit position (hexadecimal): 0

× ×

LVL Converter-specific edge contact 
register

Hexadeci
mal

LVL(Address)(Bit position)
Notation example: LVL0FE0
• Address (word unit) (hexadecimal): 000 to 

0FE
• Bit position (hexadecimal): 0

× ×

VL Edge contact Hexadeci
mal

VL(Address)(Bit position)
Notation example: VLFE0
• Address (word unit) (hexadecimal): 00 to 

FE
• Bit position (hexadecimal): 0

× ×

BD Internal register Hexadeci
mal 000 to 1FE × ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LLL -/- R/W -/- -/-

LML -/- R/W -/- -/-

LF -/- R/W -/- -/-

LG -/- R/W -/- -/-

DL -/- R/W -/- -/-

AL -/- R/W -/- -/-

SL -/- R/- -/- -/-

JL -/- R/W -/- -/-

QL -/- R/W -/- -/-

FL -/- R/W -/- -/-

LWL -/- R/W -/- -/-

LXL -/- R/W -/- -/-

XL -/- R/W -/- -/-

YL -/- R/W -/- -/-

RL -/- R/W -/- -/-

ML -/- R/W -/- -/-
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KL -/- R/W -/- -/-

TL -/- R/W -/- -/-

UL -/- R/W -/- -/-

CL -/- R/W -/- -/-

GWL -/- R/W -/- -/-

EL -/- R/W -/- -/-

NL -/- R/W -/- -/-

PL -/- R/W -/- -/-

IL -/- R/W -/- -/-

OL -/- R/W -/- -/-

BL -/- R/W -/- -/-

LBL -/- R/W -/- -/-

LRL -/- R/W -/- -/-

LVL -/- R/W -/- -/-

VL -/- R/W -/- -/-

BD -/- R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data
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12.4.25 HITACHI equipment ([HITACHI S10mini/S10V])

■1 Device setting dialog ([HITACHI S10mini/S10V])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([HITACHI S10mini/S10V])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.25 ■3 Availability of writing/reading data to/from bit devices ([HITACHI S10mini/S10V])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([HITACHI S10mini/S10V])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([HITACHI S10mini/S10V])

➟■3 Availability of writing/reading data to/from bit devices ([HITACHI S10mini/S10V])

Specifications of word devices
➟■4 Monitoring-supported word devices ([HITACHI S10mini/S10V])

➟■5 Availability of writing/reading data to/from word devices ([HITACHI S10mini/S10V])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([HITACHI S10mini/S10V])

➟■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10mini/S10V])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

X000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X External input Hexadeci
mal

X(Address)(Bit position)
Notation example: XFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Y External output Hexadeci
mal

Y(Address)(Bit position)
Notation example: YFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

GL*2 Global link register Hexadeci
mal

GL(Address)(Bit position)
Notation example: GLFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

R Internal register Hexadeci
mal

R(Address)(Bit position)
Notation example: RFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

K Keep relay Hexadeci
mal

K(Address)(Bit position)
Notation example: KFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

E Event register Hexadeci
mal

E(Address)(Bit position)
Notation example: EFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

T On-delay timer Hexadeci
mal

T(Address)(Bit position)
Notation example: T1F0
• Address (word unit) (hexadecimal): 00 to 

1F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

C Up-down counter Hexadeci
mal

C(Address)(Bit position)
Notation example: CF0
• Address (word unit) (hexadecimal): 0 to F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

U One-shot timer Hexadeci
mal

U(Address)(Bit position)
Notation example: U0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

M Extended internal register Hexadeci
mal

M(Address)(Bit position)
Notation example: MFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

A Extended internal register Hexadeci
mal

A(Address)(Bit position)
Notation example: AFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

S System register Hexadeci
mal

S(Address)(Bit position)
Notation example: SBF0
• Address (word unit) (hexadecimal): 00 to 

BF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 The global link register (GL) corresponds to the global link register (G) of the PLU CPU.

■3 Availability of writing/reading data to/from bit devices ([HITACHI S10mini/S10V])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([HITACHI S10mini/S10V])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.25 ■5 Availability of writing/reading data to/from word devices ([HITACHI S10mini/S10V])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

J Transfer register Hexadeci
mal

J(Address)(Bit position)
Notation example: JFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Q Receive register Hexadeci
mal

Q(Address)(Bit position)
Notation example: QFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- -/- -/- -/-

Y R/W -/- -/- -/- -/-

GL R/W -/- -/- -/- -/-

R R/W -/- -/- -/- -/-

K R/W -/- -/- -/- -/-

E R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

U R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

A R/W -/- -/- -/- -/-

S R/- -/- -/- -/- -/-

J R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TC On-delay timer (count value) Hexadeci
mal 000 to 1FF ○

○
(Not usable as bit 
data)
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CC Up-down counter (count value) Hexadeci
mal 00 to FF ○

○
(Not usable as bit 
data)

UC One-shot timer (count value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)

DW*2 Function data register Hexadeci
mal 000 to FFF ○ ○

AW Extension internal register Hexadeci
mal

AW(Address)(Bit position)
Notation example: AWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

SW System register Hexadeci
mal

SW(Address)(Bit position)
Notation example: SWBF0
• Address (word unit) (hexadecimal): 00 to 

BF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

JW Transfer register Hexadeci
mal

JW(Address)(Bit position)
Notation example: JWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

QW Receive register Hexadeci
mal

QW(Address)(Bit position)
Notation example: QWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

TS On-delay timer (set value) Hexadeci
mal 000 to 1FF ○

○
(Not usable as bit 
data)

US One-shot timer (set value) Hexadeci
mal 000 to 0FF ○

○
(Not usable as bit 
data)

CS Up-down counter (set value) Hexadeci
mal 00 to FF ○

○
(Not usable as bit 
data)

FW*2 Function work register Hexadeci
mal 000 to BFF ○ ○

LWW*2 Extension function work register Hexadeci
mal 0000 to FFFF ○ ○

LXW*2 Backup work register Hexadeci
mal 0000 to 3FFF ○ ○

XW External input Hexadeci
mal

XW(Address)(Bit position)
Notation example: XWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

YW External output Hexadeci
mal

YW(Address)(Bit position)
Notation example: YWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

RW Internal register Hexadeci
mal

RW(Address)(Bit position)
Notation example: RWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When it is used with bit specification of word device, the offset function cannot be used.

■5 Availability of writing/reading data to/from word devices ([HITACHI S10mini/S10V])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

MW Extension internal register Hexadeci
mal

MW(Address)(Bit position)
Notation example: MWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

KW Keep relay Hexadeci
mal

KW(Address)(Bit position)
Notation example: KWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

TW On-delay timer Hexadeci
mal

TW(Address)(Bit position)
Notation example: TW1F0
• Address (word unit) (hexadecimal): 00 to 

1F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

UW One-shot timer Hexadeci
mal

UW(Address)(Bit position)
Notation example: UW0F0
• Address (word unit) (hexadecimal): 00 to 

0F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

CW Up-down counter Hexadeci
mal

CW(Address)(Bit position)
Notation example: CWF0
• Address (word unit) (hexadecimal): 0 to F
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

GW Global link register Hexadeci
mal

GW(Address)(Bit position)
Notation example: GWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

EW Event register Hexadeci
mal

EW(Address)(Bit position)
Notation example: EWFF0
• Address (word unit) (hexadecimal): 00 to 

FF
• Bit position (hexadecimal): 0

○
○
(Not usable as bit 
data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TC R/W -/- -/- -/-

CC R/W -/- -/- -/-

UC R/W -/- -/- -/-

DW*1 R/W R/W -/- R/W

AW R/W R/W -/- -/-

SW R/- R/- -/- -/-

JW R/W R/W -/- -/-

QW R/W R/W -/- -/-

TS R/W -/- -/- -/-

US R/W -/- -/- -/-

CS R/W -/- -/- -/-
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*1 When bit specification of word device is performed, the uppermost bit is b0 and the lowermost bit is b15.

■6 Monitoring-supported double-word devices ([HITACHI S10mini/S10V])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.25 ■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10mini/S10V])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

FW*1 R/W R/W -/- R/W

LWW*1 R/W R/W -/- R/W

LXW*1 R/W R/W -/- R/W

XW R/W R/W -/- -/-

YW R/W R/W -/- -/-

RW R/W R/W -/- -/-

MW R/W R/W -/- -/-

KW R/W R/W -/- -/-

TW R/W R/W -/- -/-

UW R/W R/W -/- -/-

CW R/W R/W -/- -/-

GW R/W R/W -/- -/-

EW R/W R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

b0 b1 .......... b14 b15
Higher Lower

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

LLL Long-word work register Hexadeci
mal 0000 to 1FFF × ×

LML Backup long-word work register Hexadeci
mal 0000 to 1FFF × ×

LF Floating-point work register Hexadeci
mal 0000 to 1FFF × ×

LG Backup single-precision floating-
point work register

Hexadeci
mal 0000 to 1FFF × ×
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■7 Availability of writing/reading data to/from double-word devices ([HITACHI S10mini/S10V])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

12.4.26 HIRATA equipment ([Hirata HNC])

Contact our company for the device specifications when connecting the GOT to HIRATA equipment.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

LLL -/- R/W -/- -/-

LML -/- R/W -/- -/-

LF -/- R/W -/- -/-

LG -/- R/W -/- -/-

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.4.27 FUJI equipment ([FUJI Temperature Controller/Digital Controller])

■1 Device setting dialog ([FUJI Temperature Controller/Digital Controller])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of 00001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [1] to [199] (direct), [200] to [215] (indirect), or [216] to [255] (direct).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([FUJI Temperature Controller/Digital Controller])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([FUJI Temperature Controller/Digital Controller])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([FUJI Temperature Controller/Digital Controller])

➟■3 Availability of writing/reading data to/from bit devices ([FUJI Temperature Controller/Digital Controller])

Specifications of word devices

➟■4 Monitoring-supported word devices ([FUJI Temperature Controller/Digital Controller])

➟■5 Availability of writing/reading data to/from word devices ([FUJI Temperature Controller/Digital 
Controller])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

00001

Device name
Device number
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(1) Indirect specification of a station number ([FUJI Temperature Controller/Digital Controller])
When you specify any of 200 to 215 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported bit devices ([FUJI Temperature Controller/Digital Controller])
The following table shows monitoring-supported bit devices.
Devices are set with the coil and register numbers of the temperature controller.
For the coil numbers, register numbers, and their corresponding parameters' address maps, refer to the following.

➟Manual of the temperature controller used
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.27 ■3 Availability of writing/reading data to/from bit devices ([FUJI Temperature Controller/Digital 
Controller])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([FUJI Temperature Controller/
Digital Controller])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([FUJI Temperature Controller/Digital Controller])
The following table shows monitoring-supported word devices.
Devices are set with the coil and register numbers of the temperature controller.
For the coil numbers, register numbers, and their corresponding parameters' address maps, refer to the following.

➟Manual of the temperature controller used
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.27 ■5 Availability of writing/reading data to/from word devices ([FUJI Temperature Controller/Digital 
Controller])

For the formats of devices, refer to the following.

Station No. GOT data register (GD) Setting range

200 GD10

[1] to [119], [216] to [255]
Setting a value outside the above range causes a device range error.

201 GD11

: :

214 GD24

215 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

0 Bit data Decimal 0001 × ○

1 Bit data Decimal 0001 to 0016 × ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

0 R/W -/- -/- -/- -/-

1 R/- -/- -/- -/- -/-
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([FUJI Temperature Controller/
Digital Controller])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

3 Word data Decimal 0001 to 4907 ○ ○

4 Word data Decimal 0001 to 5032 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

3 R/- R/- -/- R/-

4 R/W R/W -/- R/W
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12.4.28 FUJI equipment ([FUJI MICREX-F])

■1 Device setting dialog ([FUJI MICREX-F])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of B0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [0] to [99].

■2 Monitoring-supported bit devices ([FUJI MICREX-F])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.28 ■3 Availability of writing/reading data to/from bit devices ([FUJI MICREX-F])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([FUJI MICREX-F])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([FUJI MICREX-F])

➟■3 Availability of writing/reading data to/from bit devices ([FUJI MICREX-F])

Specifications of word devices
➟■4 Monitoring-supported word devices ([FUJI MICREX-F])

➟■5 Availability of writing/reading data to/from word devices ([FUJI MICREX-F])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([FUJI MICREX-F])

➟■7 Availability of writing/reading data to/from double-word devices ([FUJI MICREX-F])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

B0000

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([FUJI MICREX-F])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

B I/O relay
Decimal + 
hexadecim
al

B(Word No.)(Bit No.)
Notation example: B5110
• Word No. (decimal): 000 to 511
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

L Link memory
Decimal + 
hexadecim
al

L(Word No.)(Bit No.)
Notation example: L5110
• Word No. (decimal): 000 to 511
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

M Auxiliary relay
Decimal + 
hexadecim
al

M(Word No.)(Bit No.)
Notation example: M5110
• Word No. (decimal): 000 to 511
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

K Keep relay
Decimal + 
hexadecim
al

K(Word No.)(Bit No.)
Notation example: K0630
• Word No. (decimal): 000 to 063
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

A Annunciator relay
Decimal + 
hexadecim
al

A(Word No.)(Bit No.)
Notation example: A0450
• Word No. (decimal): 000 to 045
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

T

Timer output (0.01 s) Decimal 000 to 511 ○
○
(Not usable as 
word data)

Timer output (0.1 s) Decimal 512 to 999 ○
○
(Not usable as 
word data)

C Counter output Decimal 000 to 511 ○
○
(Not usable as 
word data)

F Special relay
Decimal + 
hexadecim
al

F(Word No.)(Bit No.)
Notation example: F1250
• Word No. (decimal): 000 to 125
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

D Differential relay
Decimal + 
hexadecim
al

D(Word No.)(Bit No.)
Notation example: D0630
• Word No. (decimal): 000 to 063
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

B R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

K R/W -/- -/- -/- -/-

A R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([FUJI MICREX-F])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.28 ■5 Availability of writing/reading data to/from word devices ([FUJI MICREX-F])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When it is used with bit specification of word device, the offset function cannot be used.
*3 When writing/reading data to/from a user file, set SI data for the data format of the PLC CPU, and 16 bits for the data length 

in GT Designer3.
With any setting other than the above, the PLC does not operate normally.

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

F R/- -/- -/- -/- -/-

D R/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

WF Special relay Decimal 000 to 125 ○
○
(Not usable as bit 
data)

WD Differential relay Decimal 000 to 063 ○
○
(Not usable as bit 
data)

W24*2 Direct access Decimal
W24:(Word No.)
Notation example: W24:0255
• Word No. (decimal): 0000 to 0255

○ ○

W*2*3 User file Decimal

W(File No.):(Word No.)
Notation example: W30:4095
• File No. (decimal): 30 to 109
• Word No. (decimal): 0000 to 4095

○ ○

WB I/O relay Decimal 000 to 511 ○
○
(Not usable as bit 
data)

WM Auxiliary relay Decimal 000 to 511 ○
○
(Not usable as bit 
data)

WK Keep relay Decimal 000 to 063 ○
○
(Not usable as bit 
data)

WA Annunciator relay Decimal 000 to 045 ○
○
(Not usable as bit 
data)

WL Link memory Decimal 000 to 511 ○
○
(Not usable as bit 
data)
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■5 Availability of writing/reading data to/from word devices ([FUJI MICREX-F])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 When bit specification of word device is performed, the uppermost bit is b0 and the lowermost bit is b15.

■6 Monitoring-supported double-word devices ([FUJI MICREX-F])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.28 ■7 Availability of writing/reading data to/from double-word devices ([FUJI MICREX-F])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Decimal points are not displayed.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

WF R/- R/- -/- -/-

WD R/W R/W -/- -/-

W24*1 R/W R/W -/- R/W

W*1 R/W -/- -/- R/W

WB R/W R/W -/- -/-

WM R/W R/W -/- -/-

WK R/W R/W -/- -/-

WA R/W R/W -/- -/-

WL R/W R/W -/- -/-

b0 b1 .......... b14 b15
Higher Lower

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TR*2 Timer current value (0.01 s) Decimal 000 to 511 × ×

CR*2 Counter current value Decimal 000 to 511 × ×

BD Data memory Decimal 0000 to 4095 × ×

TS*2 Timer set value (0.01 s) Decimal 000 to 511 × ×

W9*2 Timer current value (0.1 s) Decimal
W9:(Word No.)
Notation example: W9:0487
• Word No. (decimal): 0000 to 0487

× ×

CS*2 Counter set value Decimal 000 to 511 × ×
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■7 Availability of writing/reading data to/from double-word devices ([FUJI MICREX-F])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

TR -/- R/W -/- -/-

CR -/- R/W -/- -/-

BD -/- R/W -/- -/-

TS -/- R/W -/- -/-

W9 -/- R/W -/- -/-

CS -/- R/W -/- -/-
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12.4.29 FUJI equipment ([FUJI MICREX-SX SPH])

■1 Device setting dialog ([FUJI MICREX-SX SPH])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of M0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [CPU No.]
Set the CPU number of the controller.

5) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

6) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

7) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([FUJI MICREX-SX SPH])

Specifications of word devices
➟■2 Monitoring-supported word devices ([FUJI MICREX-SX SPH])

➟■3 Availability of writing/reading data to/from word devices ([FUJI MICREX-SX SPH])

Notation of devices ➟■4 Notation of devices ([FUJI MICREX-SX SPH])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

4)
5)

6)

7)

M0

Device name
Device number
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■2 Monitoring-supported word devices ([FUJI MICREX-SX SPH])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.29 ■3 Availability of writing/reading data to/from word devices ([FUJI MICREX-SX SPH])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from word devices ([FUJI MICREX-SX SPH])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

■4 Notation of devices ([FUJI MICREX-SX SPH])
The notation of devices differs between the FUJI PLC programming software and GT Designer3.
The notation also differs according to the type of FUJI PLC programming software.

(1) Notation of devices in the single CPU system ([FUJI MICREX-SX SPH])
n: Device number

*1 The device number is not displayed when it is 0.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

M Non-retain memory Decimal 0 to 2097151 ○ ○

L Retain memory Decimal 0 to 2097151 ○ ○

SM System memory Decimal 0 to 511 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

M R/W R/W -/- R/W

L R/W R/W -/- R/W

SM R/W R/W -/- R/W

Device Notation of devices in GT Designer3
Notation of devices in the PLC programming software

SX-Programmer Expert 
(D300win) SX-Programmer Standard

Non-retain memory

Word device
Mn

%MW1.n WMn

Double-word device %MD1.n DMn

Bit-specified word device Mn.b0 to Mn.b15 %MX1.n.01 to %MX1.n.15 Mn0 to MnF*1

Retain memory

Word device
Ln

%MW3.n WLn

Double-word device %MD3.n DLn

Bit-specified word device Ln.b0 to Ln.b15 %MX3.n.01 to %MX3.n.15 Ln0 to LnF*1

System memory

Word device
SMn

%MW10.n WSMn

Double-word device %MD10.n DSMn

Bit-specified word device SMn.b0 to SMn.b15 %MX10.n.01 to %MX10.n.15 SMn0 to SMnF*1
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(2) Notation of devices in the multiple CPU system ([FUJI MICREX-SX SPH])
n: Device number
p: CPU number

*1 The device number is not displayed when it is 0.

12.4.30 MURATEC equipment ([Muratec MPC/MCR])

Contact our company for the device specifications when connecting the GOT to MURATEC equipment.

Device Notation of devices in GT Designer3
Notation of devices in the PLC programming software

SX-Programmer Expert 
(D300win) SX-Programmer Standard

Non-retain memory

Word device
0-FF/p Mn

%MWp.1.n WMp.n

Double-word device %MDp.1.n DMp.n

Bit-specified word device 0-FF/p Mn.b0 to 0-FF/p Mn.b15 %MXp.1.n.01 to %MXp.1.n.15 Mp.n0 to Mp.nF*1

Retain memory

Word device
0-FF/p Ln

%MWp.3.n WLp.n

Double-word device %MDp.3.n DLp.n

Bit-specified word device 0-FF/p Ln.b0 to 0-FF/p Ln.b15 %MXp.3.n.01 to %MXp.3.n.15 Lp.n0 to Lp.nF*1

System memory

Word device
0-FF/p SMn

%MWp.10.n WSMp.n

Double-word device %MDp.10.n DSMp.n

Bit-specified word device %MXp.10.n.01 to %MXp.10.n.15 %MX10.n.01 to %MX10.n.15 SMp.n0 to SMp.nF*1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.4.31 YASKAWA equipment ([YASKAWA GL/PROGIC8])

■1 Device setting dialog ([YASKAWA GL/PROGIC8])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of O1

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([YASKAWA GL/PROGIC8])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.31 ■3 Availability of writing/reading data to/from bit devices ([YASKAWA GL/PROGIC8])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA GL/PROGIC8])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YASKAWA GL/PROGIC8])

➟■3 Availability of writing/reading data to/from bit devices ([YASKAWA GL/PROGIC8])

Specifications of word devices

➟■4 Monitoring-supported word devices ([YASKAWA GL/PROGIC8])

➟■5 Display values of link register and holding register ([YASKAWA GL/PROGIC8])

➟■6 Availability of writing/reading data to/from word devices ([YASKAWA GL/PROGIC8])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

O1

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I*2 Input relay Decimal 1 to 63424 ○ ○

O*3 Coil Decimal 1 to 63424 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Change the input relay 10001 to 14096 to I1 to I4096 for setting. (When set in default)
*3 Set the internal coil N1 to N1536 as O513 to O2048.

However, setting must not exceed O1 to O512 and O513 to O2048.

■3 Availability of writing/reading data to/from bit devices ([YASKAWA GL/PROGIC8])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([YASKAWA GL/PROGIC8])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.31 ■6 Availability of writing/reading data to/from word devices ([YASKAWA GL/PROGIC8])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 For the relationship between SR/SW and R/W, refer to the following.

D Link coil Decimal

D(Channel No.)(Device)
Notation example: D12048
• Channel No. (decimal): 0 to 2
• Device (decimal): 1 to 2048
When [Channel No.] is [0], (Channel No.) is 
unnecessary.

○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/- -/- R/- R/- -/-

O R/W -/- R/W R/W -/-

D R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Z*3 Input register Decimal 1 to 31840 ○ ○

R*2 Link register Decimal

R(Channel No.)(Device)
Notation example: R12048
• Channel No. (decimal): 0 to 2
• Device (decimal): 1 to 2048
When [Channel No.] is [0], (Channel No.) is 
unnecessary.

○ ○

W*2*4 Holding register Decimal 1 to 28291 ○ ○

K*5 Constant register Decimal 1 to 4096 ○ ○

SW*2 Holding register Decimal 1 to 28291 ○ ○

SR*2 Link register Decimal

SR(Channel No.)(Device)
Notation example: SR12048
• Channel No. (decimal): 0 to 2
• Device (decimal): 1 to 2048
When [Channel No.] is [0], (Channel No.) is 
unnecessary.

○ ○
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➟12.4.31 ■5 Display values of link register and holding register ([YASKAWA GL/PROGIC8])
*3 Change the input register 30001 to 30512 to Z1 to Z512 for setting. (When set in default)
*4 Change the holding register 40001 to 49999 to W1 to W9999 for setting. (When set in default)
*5 Change the constant register 31001 to 35096 to K1 to K4096 for setting. (When set in default)

■5 Display values of link register and holding register ([YASKAWA GL/PROGIC8])
SR and SW are virtual registers compatible with the data format used to display internal data of PLCs using R or W.
The following shows the difference between the display values of SR/SW and those of R/W corresponding to the values 
of PLC internal data.

■6 Availability of writing/reading data to/from word devices ([YASKAWA GL/PROGIC8])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

PLC internal data (16 bits) SR, SW R, W

9999 9999 9999

1001 1001 1001

1000 1000 1000

999 999 999

0 0 0

-1 -1 32769

-999 -999 33767

-1000 -1000 33768

-1001 -1001 33769

-9999 -9999 42767

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Z R/- R/- -/- R/-

R R/W R/W -/- R/W

W R/W R/W -/- R/W

K R/W R/W -/- R/W

SW R/W R/W -/- R/W

SR R/W R/W -/- R/W
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12.4.32 YASKAWA equipment ([YASKAWA CP9200(H)])

■1 Device setting dialog ([YASKAWA CP9200(H)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of OB0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([YASKAWA CP9200(H)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.32 ■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9200(H)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA CP9200(H)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YASKAWA CP9200(H)])

➟■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9200(H)])

Specifications of word devices
➟■4 Monitoring-supported word devices ([YASKAWA CP9200(H)])

➟■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9200(H)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

OB0000

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IB*2 Input relay Hexadeci
mal 0000 to 07FF ○ ○

OB*2 Coil Hexadeci
mal 0000 to 07FF ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 During operation of CP-9200H, specify the reference No. and quantities so that they do not cover both IB*** and OB***.

■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9200(H)])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([YASKAWA CP9200(H)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.32 ■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9200(H)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 To use data registers of CPU #1 during operation of CP-9200, copy them to MW0 to MW7694.

■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9200(H)])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IB R/W -/- R/W R/W -/-

OB R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DW Data register Decimal 0 to 2047 ○ ○

MW*2 Common register Decimal 0 to 7694 ○ ○

IW Input register Hexadeci
mal 0000 to 007F ○ ○

OW Output register Hexadeci
mal 0000 to 007F ○ ○

ZD Data register Decimal 0 to 2047 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

DW R/W R/W -/- R/W

MW R/W R/W -/- R/W

IW R/W R/W -/- R/W

OW R/W R/W -/- R/W

ZD R/W R/W -/- R/W
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12.4.33 YASKAWA equipment ([YASKAWA CP9300MS(MC compatible)])

■1 Device setting dialog ([YASKAWA CP9300MS(MC compatible)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of OB0

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([YASKAWA CP9300MS(MC compatible)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.33 ■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9300MS(MC compatible)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA CP9300MS(MC compatible)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YASKAWA CP9300MS(MC compatible)])

➟■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9300MS(MC compatible)])

Specifications of word devices
➟■4 Monitoring-supported word devices ([YASKAWA CP9300MS(MC compatible)])

➟■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9300MS(MC compatible)])
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2) 3)

1)

OB0

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IB Input relay Decimal 0 to 1023 ○ ○

OB Coil Decimal 0 to 1023 ○ ○
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➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([YASKAWA CP9300MS(MC 
compatible)])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([YASKAWA CP9300MS(MC compatible)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.33 ■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9300MS(MC 
compatible)])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([YASKAWA CP9300MS(MC 
compatible)])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IB R/- -/- R/- R/- -/-

OB R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

M Data register Decimal 0 to 2047 ○ ○

I Input register Decimal 0 to 63 ○ ○

o Output register Decimal 0 to 63 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

M R/W R/W -/- R/W

I R/W R/W -/- R/W

o R/W R/W -/- R/W
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12.4.34 YASKAWA equipment ([YASKAWA MP2000/MP900/CP9200SH])

■1 Device setting dialog ([YASKAWA MP2000/MP900/CP9200SH])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of MB000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA MP2000/MP900/CP9200SH])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YASKAWA MP2000/MP900/CP9200SH])

➟■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP2000/MP900/CP9200SH])

Specifications of word devices
➟■4 Monitoring-supported word devices ([YASKAWA MP2000/MP900/CP9200SH])

➟■5 Availability of writing/reading data to/from word devices ([YASKAWA MP2000/MP900/CP9200SH])
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2) 3)

4)

1)

5)

6)

MB000000

Device name
Device number
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■2 Monitoring-supported bit devices ([YASKAWA MP2000/MP900/CP9200SH])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.34 ■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP2000/MP900/CP9200SH])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP2000/MP900/
CP9200SH])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([YASKAWA MP2000/MP900/CP9200SH])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.34 ■5 Availability of writing/reading data to/from word devices ([YASKAWA MP2000/MP900/
CP9200SH])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IB Input relay Hexadeci
mal 00000 to 7FFFF ○ ○

MB Coil
Decimal + 
hexadecim
al

MB(Word address)(Bit No.)
Notation example: MB655340
The rightmost digit is a bit address.
• Channel No. (decimal): 00000 to 65534
• Bit No. (hexadecimal): 0 to F

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IB R/- -/- R/- R/- -/-

MB R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IW Input register Hexadeci
mal 0000 to 7FFF ○ ○

MW Holding register Decimal 0 to 65534 ○ ○
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■5 Availability of writing/reading data to/from word devices ([YASKAWA MP2000/MP900/
CP9200SH])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 For the CP-317, only reading is possible for bit specification of word devices.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

IW R/- R/- -/- R/-

MW*1 R/W R/W -/- R/W
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12.4.35 YASKAWA equipment ([YASKAWA MP3000])

■1 Device setting dialog ([YASKAWA MP3000])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of MB00000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA MP3000])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YASKAWA MP3000])

➟■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP3000])

Specifications of word devices
➟■4 Monitoring-supported word devices ([YASKAWA MP3000])

➟■5 Availability of writing/reading data to/from word devices ([YASKAWA MP3000])
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2) 3)

4)

1)

5)

6)

MB00000000

Device name
Device number
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■2 Monitoring-supported bit devices ([YASKAWA MP3000])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.35 ■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP3000])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 This device is displayed as GB in the peripherals of the YASKAWA PLC.

■3 Availability of writing/reading data to/from bit devices ([YASKAWA MP3000])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IB Input register Hexadeci
mal 000000 to 21FFFF ○ ○

OB Output register Hexadeci
mal 000000 to 21FFFF ○ ○

MB Data register
Decimal + 
hexadecim
al

MB(Word address)(Bit No.)
Notation example: MB10485750
The rightmost digit is a bit address.
• Channel No. (decimal): 0000000 to 

1048575
• Bit No. (hexadecimal): 0 to F

○ ○

YGB*2 G register
Decimal + 
hexadecim
al

YGB(Word address)(Bit No.)
Notation example: YGB20971510
The rightmost digit is a bit address.
• Channel No. (decimal): 0000000 to 

2097151
• Bit No. (hexadecimal): 0 to F

○ ○

SB System register
Decimal + 
hexadecim
al

SB(Word address)(Bit No.)
Notation example: SB655340
The rightmost digit is a bit address.
• Channel No. (decimal): 00000 to 65534
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IB R/- -/- R/- R/- -/-

OB R/W -/- R/W R/W -/-

MB R/W -/- R/W R/W -/-

YGB R/W -/- R/W R/W -/-

SB R/W -/- R/W R/W -/-
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■4 Monitoring-supported word devices ([YASKAWA MP3000])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.35 ■5 Availability of writing/reading data to/from word devices ([YASKAWA MP3000])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 This device is displayed as GW in the peripherals of the YASKAWA PLC.

■5 Availability of writing/reading data to/from word devices ([YASKAWA MP3000])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IW Input register Hexadeci
mal 00000 to 21FFF ○ ○

OW Output register Hexadeci
mal 00000 to 21FFF ○ ○

MW Data register Decimal 0 to 1048575 ○ ○

YGW*2 G register Decimal 0 to 2097151 ○ ○

SW System register Decimal 0 to 65534 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

IW R/- R/- -/- R/-

OW R/W R/W -/- R/W

MW R/W R/W -/- R/W

YGW R/W R/W -/- R/W

SW R/W R/W -/- R/W
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12.4.36 YASKAWA equipment ([YASKAWA Robot Controller])

■1 Device setting dialog ([YASKAWA Robot Controller])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of IO10

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YASKAWA Robot Controller])

Specifications of bit devices

➟■2 Monitoring-supported bit devices ([YASKAWA Robot Controller])

➟■3 IO Data device details ([YASKAWA Robot Controller])

➟■4 Availability of writing/reading data to/from bit devices ([YASKAWA Robot Controller])

Specifications of byte devices
➟■5 Monitoring-supported byte devices ([YASKAWA Robot Controller])

➟■6 Availability of writing/reading data to/from byte devices ([YASKAWA Robot Controller])

Specifications of word devices

➟■7 Monitoring-supported word devices ([YASKAWA Robot Controller])

➟■8 Robot Control device details ([YASKAWA Robot Controller])

➟■9 Availability of writing/reading data to/from word devices ([YASKAWA Robot Controller])

Specifications of double-word 
devices

➟■10 Monitoring-supported double-word devices ([YASKAWA Robot Controller])

➟■11 Availability of writing/reading data to/from double-word devices ([YASKAWA Robot Controller])

Precautions ➟■12 Precautions ([YASKAWA Robot Controller])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

IO10

Device name
Device number
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5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.
The setting range is [1] (fixed).

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.
The setting range is [1] to [120].

■2 Monitoring-supported bit devices ([YASKAWA Robot Controller])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.36 ■4 Availability of writing/reading data to/from bit devices ([YASKAWA Robot Controller])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 IO Data device details ([YASKAWA Robot Controller])
The following shows the relationship between the data and device range of the robot controller.
The rightmost digit of each device number is a bit address.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IO IO Data Decimal + 
octal

IO(Byte address)(Bit address)
Notation example: IO87200
The rightmost digit is a bit address.
• Byte address (decimal): 1 to 8720
• Bit address (octal): 0 to 7
For the relationship between the data and 
device range of the robot controller, refer to 
the following.

➟12.4.36 ■3 IO Data device details 
([YASKAWA Robot Controller])

○ ○

Device range Virtual device name

10 to 5127 Robot general-purpose input

10010 to 15127 Robot general-purpose output

20010 to 25127 External input

27010 to 29567 Network input

30010 to 35127 External output

37010 to 39567 Network output

40010 to 42567 Robot-dedicated input

50010 to 55127 Robot-dedicated output

60010 to 60647 Interface panel input

70010 to 79997 Auxiliary relay

80010 to 85127 Robot control status

87010 to 87207 Pseudo input
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■4 Availability of writing/reading data to/from bit devices ([YASKAWA Robot Controller])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Availability of reading/writing depends on the device number.

➟12.4.36 ■3 IO Data device details ([YASKAWA Robot Controller])

■5 Monitoring-supported byte devices ([YASKAWA Robot Controller])
The following table shows monitoring-supported byte devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.36 ■6 Availability of writing/reading data to/from byte devices ([YASKAWA Robot Controller])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■6 Availability of writing/reading data to/from byte devices ([YASKAWA Robot Controller])
The following shows whether writing/reading data to/from byte devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■7 Monitoring-supported word devices ([YASKAWA Robot Controller])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.36 ■9 Availability of writing/reading data to/from word devices ([YASKAWA Robot Controller])
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IO*1 R/W -/- R/W -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

B Byte Variable Decimal 0 to 1999 × ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

B -/- R/W -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Integer Variable Decimal 0 to 1999 ○ ○

M Resister Data Decimal 0 to 999 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Not available for a text display or text input object.

■8 Robot Control device details ([YASKAWA Robot Controller])
Data that can be acquired using the Robot Control is assigned to the GOT virtual device (RC device).
Specify the Command No., Instance, and Attribute for the RC device to enable monitoring of the corresponding data.
Note the following when using the RC device.

For details on each command, refer to the following.
➟Manual of the YASKAWA robot controller

The GOT supports the following commands.

RC*2 Robot Control

Hexadeci
mal + 
decimal + 
decimal

RC(Command No.)-(Instance)((Attribute))
Notation example: RC70-8720(13)
• Command No. (hexadecimal): 70 to 8C, 

300 to 30C
• Instance (decimal): 0 to 8720
• Attribute (decimal): 0 to 13
For the relationship between data that can 
be acquired using Robot Control and the 
virtual GOT devices, refer to the following.

➟12.4.36 ■8 Robot Control device details 
([YASKAWA Robot Controller])

× ×

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Precautions Description

Basic use of the RC device

Read all the elements to a GOT internal device in a batch using the script function or device 
data transfer function to monitor the data stored in the device.
Setting the RC device to an object or others to monitor each element individually will decrease 
the monitoring speed.

Setting of the device data type and number of 
devices

Check the size of each data corresponding to the Command No., Instance, and Attribute to be 
specified.
Set the data type and number of devices in the device settings so that the corresponding data 
can be stored.

Objects for which the RC device cannot be used

Do not specify the RC device directly in the following object settings for which consecutive 
devices are used.
• Text display: Monitor device
• Text input: Monitor device
• Parts movement: [Device] (When [Position] is selected for [Move Way])
• Simple alarm display: Monitor device (When [Continuous] is selected for [Device No.])
• Recipe display (record list): [Control target record name], [Narrow down record names], or 

[Cursor row record name]
• Trend graph: Monitor device (When [Continuous] is selected for [Device Setting])
• Document display: [Keyword Device]
• Text print: Monitor device
As described in the column for Basic use of the RC device, read all the elements to a GOT 
internal device in a batch to monitor the data stored in the device.

Command No. (hexadecimal) Command name

72 Status information read command

73 Execution job information read command

74 Axis configuration information read command

75 Robot position data read command

76 Position deviation read command

77 Torque data read command

7F Robot position variable (P) read/write command

82 Alarm reset/error cancel command

88 Control time acquisition command

307 Robot position variable (P) multi-read/-write command

30A Alarm data read command (subcode character string supported)

30B Alarm history read command (subcode character string supported)
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■9 Availability of writing/reading data to/from word devices ([YASKAWA Robot Controller])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■10 Monitoring-supported double-word devices ([YASKAWA Robot Controller])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.36 ■11 Availability of writing/reading data to/from double-word devices ([YASKAWA Robot Controller])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■11 Availability of writing/reading data to/from double-word devices ([YASKAWA Robot 
Controller])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■12 Precautions ([YASKAWA Robot Controller])
(1) Precautions when writing devices in a batch ([YASKAWA Robot Controller])

When many devices are written in a batch using the recipe function or device data transfer function, system alarm 402 
(communication timeout error) may occur.
Take either of the following corrective actions.

• Specifying a longer communication timeout period
• Reducing the number of devices written in a batch

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

I R/W -/- -/- -/-

M R/W -/- -/- -/-

RC R/W R/W -/- R/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

D Double Int Variable Decimal 0 to 1999 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

D -/- R/W -/- -/-
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12.4.37 YOKOGAWA equipment ([YOKOGAWA STARDOM/FA500/FA-M3])

■1 Device setting dialog ([YOKOGAWA STARDOM/FA500/FA-M3])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X00201

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [CPU No.]
Set the CPU number of the controller.
When monitoring a single CPU system, set the CPU No. to [0].
When monitoring a multiple CPU system, set the CPU No. to any of [0] to [4].
When [0] is set, the GOT monitors CPU No. 1.

5) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

6) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

7) [Station No.]

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YOKOGAWA STARDOM/FA500/FA-M3])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([YOKOGAWA STARDOM/FA500/FA-M3])

➟■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA STARDOM/FA500/FA-M3])

Specifications of word devices
➟■4 Monitoring-supported word devices ([YOKOGAWA STARDOM/FA500/FA-M3])

➟■5 Availability of writing/reading data to/from word devices ([YOKOGAWA STARDOM/FA500/FA-M3])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

4)
5)

6)

7)

X00201

Device name
Device number
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This item appears when [Other] is selected for the station type.
Specify a station number.

■2 Monitoring-supported bit devices ([YOKOGAWA STARDOM/FA500/FA-M3])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.37 ■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA STARDOM/FA500/FA-M3])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
If a device outside the setting range is set for an object, the value display at the object is indefinite.
However, no error is displayed for system alarm.
A device to be set for an object must be in the device range of YOKOGAWA PLC.
For the device range of YOKOGAWA PLC, refer to the manual below.

➟Manual of YOKOGAWA PLC
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA STARDOM/FA500/FA-
M3])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input relay Decimal + 
decimal

X(Slot No.)(Terminal No.)
Notation example: X71601
• Slot No. (decimal): 002 to 716
• Terminal No. (decimal): 01 to 64

○ ○

Y Output relay Decimal + 
decimal

Y(Slot No.)(Terminal No.)
Notation example: Y71601
• Slot No. (decimal): 002 to 716
• Terminal No. (decimal): 01 to 64

○ ○

I Internal relay Decimal 1 to 65535 ○ ○

TU Timer Decimal 1 to 3072 ○
○
(Not usable as 
word data)

CU Counter Decimal 1 to 3072 ○
○
(Not usable as 
word data)

M Special relay Decimal 1 to 9984 ○ ○

L Link relay Decimal + 
decimal

L(FA link relay No. - 1)(Link relay No.)
Notation example: L70001
• FA link module No. - 1 (decimal): 0 to 7 

(Set the link module No. minus 1.)
• Link relay No. (decimal): 0001 to 8192

○ ○

E Shared relay Decimal 1 to 4096 ○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/- -/- R/- R/- -/-

Y R/W -/- R/W R/W -/-

I R/W -/- R/W R/W -/-

TU R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([YOKOGAWA STARDOM/FA500/FA-M3])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.37 ■5 Availability of writing/reading data to/from word devices ([YOKOGAWA STARDOM/FA500/FA-
M3])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

CU R/W -/- -/- -/- -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

E R/W -/- R/W R/W -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TP Timer Decimal 1 to 3072 ○
○
(Not usable as bit 
data)

CP Counter Decimal 1 to 3072 ○
○
(Not usable as bit 
data)

D Data register Decimal 1 to 65535 ○ ○

Z Special register Decimal 1 to 1024 ○ ×

B File register Decimal 1 to 262144 ○ ○

V Index register Decimal 1 to 256 ○ ○

TS Timer Decimal 1 to 3072 ○
○
(Not usable as bit 
data)

CS Counter Decimal 1 to 3072 ○
○
(Not usable as bit 
data)

R Shared register Decimal 1 to 4096 ○ ○

W Link register Decimal + 
decimal

W(FA link module No. - 1)(Link register No.)
Notation example: W70001
• FA link module No. - 1 (decimal): 0 to 7 

(Set the link module No. minus 1.)
• Link register No. (decimal): 0001 to 8192

○ ×

F Cache register Decimal 000001 to 524288 ○ ○
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■5 Availability of writing/reading data to/from word devices ([YOKOGAWA STARDOM/FA500/
FA-M3])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TP R/W R/W -/- -/-

CP R/W R/W -/- -/-

D R/W R/W -/- R/W

Z R/W R/W -/- R/W

B R/W R/W -/- R/W

V R/W R/W -/- R/W

TS R/- R/- -/- -/-

CS R/- R/- -/- -/-

R R/W R/W -/- R/W

W R/W R/W -/- R/W

F R/W R/W -/- R/W
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12.4.38 YOKOGAWA equipment ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])

■1 Device setting dialog ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I0001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Monitor target specification
Set the monitor target of the set device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])

Specifications of bit devices

➟■2 Monitoring-supported bit devices ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])

➟■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced])

Specifications of word devices

➟■4 Monitoring-supported word devices ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])

➟■5 Availability of writing/reading data to/from word devices ([YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Description

[All]

Select this item when writing data to all the connected temperature controllers.
During monitoring, the temperature controller set for [Host Address] of the [Controller 
Setting] window is monitored.
When data is input from a numerical input object, the data is written to all the connected 
temperature controllers. When no data is input, the temperature controller set for [Host 
Address] is monitored.
When bit specification of word device is performed, data is written to the temperature 
controller set for [Host Address].

2) 3)

1)

4)
5)

I0001

Device name
Device number
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5) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [99] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])

(1) Indirect specification of a station number ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported bit devices ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.38 ■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([YOKOGAWA GREEN/UT100/
UT2000/UTAdvanced])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

[Selection] Select this item when monitoring the temperature controller that has the specified station 
number.

Item Description

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [99]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Internal relay Decimal

C(CPU No.)-I(Device)
Notation example: C2-I0001
• CPU No. (decimal): 1 to 2
• Device (decimal): 0001 to 7072
When there is no setting for the CPU No. in 
the communication settings on the 
temperature controller side, set the CPU 
No. on the GOT side to 1 (default).

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- R/W -/- -/-
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■4 Monitoring-supported word devices ([YOKOGAWA GREEN/UT100/UT2000/UTAdvanced])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.38 ■5 Availability of writing/reading data to/from word devices ([YOKOGAWA GREEN/UT100/UT2000/
UTAdvanced])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([YOKOGAWA GREEN/UT100/
UT2000/UTAdvanced])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

D Data register Decimal

C(CPU No.)-D(Device)
Notation example: C2-D0001
• CPU No. (decimal): 1 to 2
• Device (decimal): 0001 to 9000
When there is no setting for the CPU No. in 
the communication settings on the 
temperature controller side, set the CPU 
No. on the GOT side to 1 (default).

○ ○

B File register Decimal 0001 to 1600 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

D R/W -/- -/- R/W

B R/W -/- -/- R/W
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12.4.39 RKC equipment ([RKC SR Mini HG])

■1 Device setting dialog ([RKC SR Mini HG])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of ..0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
Set it by a value of unit address +1 in decimal.
Example 1) When the unit address is 0: Set 1.
Example 2) When the unit address is F: Set 16.
The setting range is [0] to [99] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([RKC SR Mini HG])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([RKC SR Mini HG])

Specifications of word devices
➟■2 Monitoring-supported word devices ([RKC SR Mini HG])

➟■3 Availability of writing/reading data to/from word devices ([RKC SR Mini HG])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

..0000

Device name
Device number
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(1) Indirect specification of a station number ([RKC SR Mini HG])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported word devices ([RKC SR Mini HG])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.39 ■3 Availability of writing/reading data to/from word devices ([RKC SR Mini HG])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from word devices ([RKC SR Mini HG])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [99]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

.. Data Hexadeci
mal 0000 to FFFF ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

.. R/W R/W -/- R/W
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12.4.40 ALLEN-BRADLEY equipment ([AB SLC500])

■1 Device setting dialog ([AB SLC500])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of B3:0/0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([AB SLC500])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([AB SLC500])

➟■3 Availability of writing/reading data to/from bit devices ([AB SLC500])

Specifications of word devices
➟■4 Monitoring-supported word devices ([AB SLC500])

➟■5 Availability of writing/reading data to/from word devices ([AB SLC500])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

B3:0/0

Device name
Device number
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■2 Monitoring-supported bit devices ([AB SLC500])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.40 ■3 Availability of writing/reading data to/from bit devices ([AB SLC500])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([AB SLC500])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T

Timer (completion bit)

Decimal

T(File No.):(Element No.)/13(DN)
Notation example: T4:255/13(DN)
• File No. (decimal): 4 to 255
• Element No. (decimal): 0 to 255

○ ×

Timer (timing bit)

T(File No.):(Element No.)/14(TT)
Notation example: T4:255/14(TT)
• File No. (decimal): 4 to 255
• Element No. (decimal): 0 to 255

C

Counter (completion bit)

Decimal

C(File No.):(Element No.)/13(DN)
Notation example: C5:255/13(DN)
• File No. (decimal): 5 to 255
• Element No. (decimal): 0 to 255

○ ×Counter (down counter)

C(File No.):(Element No.)/14(CD)
Notation example: C5:255/14(CD)
• File No. (decimal): 5 to 255
• Element No. (decimal): 0 to 255

Counter (up counter)

C(File No.):(Element No.)/15(CU)
Notation example: C5:255/15(CU)
• File No. (decimal): 5 to 255
• Element No. (decimal): 0 to 255

B Bit Decimal

B(File No.):(Element No.)/(Bit position)
Notation example: B3:255/0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255
• Bit position (decimal): 0 to 15

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

B R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([AB SLC500])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.40 ■5 Availability of writing/reading data to/from word devices ([AB SLC500])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([AB SLC500])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T

Timer (set value)

Decimal

T(File No.):(Element No.).1(PRE)
Notation example: T4:255.1(PRE)
• File No. (decimal): 4 to 255
• Element No. (decimal): 0 to 255

○ ×

Timer (current value)

T(File No.):(Element No.).2(ACC)
Notation example: T4:255.2(ACC)
• File No. (decimal): 4 to 255
• Element No. (decimal): 0 to 255

C

Counter (set value)

Decimal

C(File No.):(Element No.).1(PRE)
Notation example: C5:255.1(PRE)
• File No. (decimal): 5 to 255
• Element No. (decimal): 0 to 255

○ ×

Counter (current value)

C(File No.):(Element No.).2(ACC)
Notation example: C5:255.2(ACC)
• File No. (decimal): 5 to 255
• Element No. (decimal): 0 to 255

N Integer Decimal

N(File No.):(Element No.)
Notation example: N7:255
• File No. (decimal): 7 to 255
• Element No. (decimal): 0 to 255

○ ○

B Bit Decimal

B(File No.):(Element No.)
Notation example: B3:255
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

T R/W R/- -/- R/W

C R/W R/- -/- R/W

N R/W R/W -/- R/W

B R/W R/W -/- -/-
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12.4.41 ALLEN-BRADLEY equipment ([AB MicroLogix])

■1 Device setting dialog ([AB MicroLogix])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of B3:0/0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([AB MicroLogix])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([AB MicroLogix])

➟■3 Availability of writing/reading data to/from bit devices ([AB MicroLogix])

Specifications of word devices
➟■4 Monitoring-supported word devices ([AB MicroLogix])

➟■5 Availability of writing/reading data to/from word devices ([AB MicroLogix])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([AB MicroLogix])

➟■7 Availability of writing/reading data to/from double-word devices ([AB MicroLogix])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

B3:0/0

Device name
Device number
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■2 Monitoring-supported bit devices ([AB MicroLogix])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.41 ■3 Availability of writing/reading data to/from bit devices ([AB MicroLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T

Timer (completion bit)

Decimal

T(File No.):(Element No.)/13(DN)
Notation example: T3:255/13(DN)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ×

Timer (timing bit)

T(File No.):(Element No.)/14(TT)
Notation example: T3:255/14(TT)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

C

Counter (completion bit)

Decimal

C(File No.):(Element No.)/13(DN)
Notation example: C3:255/13(DN)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ×Counter (down counter)

C(File No.):(Element No.)/14(CD)
Notation example: C3:255/14(CD)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

Counter (up counter)

C(File No.):(Element No.)/15(CU)
Notation example: C3:255/15(CU)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

I Input Decimal

I:(Slot No.).(Element No.)/(Bit position)
Notation example: I:16.7/0
• Slot No. (decimal): 0 to 16
• Element No. (decimal): 0 to 7
• Bit position (decimal): 0 to 15

○ ○

O Output Decimal

O:(Slot No.).(Element No.)/(Bit position)
Notation example: O:16.7/0
• Slot No. (decimal): 0 to 16
• Element No. (decimal): 0 to 7
• Bit position (decimal): 0 to 15

○ ○

B Bit Decimal

B(File No.):(Element No.)/(Bit position)
Notation example: B3:255/0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255
• Bit position (decimal): 0 to 15

○ ○
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■3 Availability of writing/reading data to/from bit devices ([AB MicroLogix])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([AB MicroLogix])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.41 ■5 Availability of writing/reading data to/from word devices ([AB MicroLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

I R/W -/- -/- -/- -/-

O R/W -/- -/- -/- -/-

B R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input Decimal

I:(Slot No.).(Element No.)
Notation example: I:16.0
• Slot No. (decimal): 0 to 16
• Element No. (decimal): 0 to 7

○ ○

O Output Decimal

O:(Slot No.).(Element No.)
Notation example: O:16.0
• Slot No. (decimal): 0 to 16
• Element No. (decimal): 0 to 7

○ ○

T

Timer (set value)

Decimal

T(File No.):(Element No.).1(PRE)
Notation example: T3:255.1(PRE)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ×

Timer (current value)

T(File No.):(Element No.).2(ACC)
Notation example: T3:255.2(ACC)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

C

Counter (set value)

Decimal

C(File No.):(Element No.).1(PRE)
Notation example: C3:255.1(PRE)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ×

Counter (current value)

C(File No.):(Element No.).2(ACC)
Notation example: C3:255.2(ACC)
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

N Integer Decimal

N(File No.):(Element No.)
Notation example: N7:0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ○

B Bit Decimal

B(File No.):(Element No.)
Notation example: B3:0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([AB MicroLogix])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 The GOT reads the value from a device and then write a value to the device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

■6 Monitoring-supported double-word devices ([AB MicroLogix])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.41 ■7 Availability of writing/reading data to/from double-word devices ([AB MicroLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

S Status Decimal

S(File No.):(Device)
Notation example: S2:163
• File No. (decimal): 2
• Device (decimal): 0 to 163

○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data*1

I R/W R/W -/- -/-

O R/W R/W -/- -/-

T R/W R/- -/- R/W

C R/W R/- -/- R/W

N R/W R/W -/- R/W

B R/W R/W -/- -/-

S R/W R/W -/- R/W

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

L 32bit integer Decimal

L(File No.):(Element No.)
Notation example: L3:0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

× ×

F 32bit float Decimal

F(File No.):(Element No.)
Notation example: F3:0
• File No. (decimal): 3 to 255
• Element No. (decimal): 0 to 255

× ×
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■7 Availability of writing/reading data to/from double-word devices ([AB MicroLogix])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

12.4.42 ALLEN-BRADLEY equipment ([AB MicroLogix (Extended)])

Contact our company for the device specifications when connecting the GOT to ALLEN-BRADLEY equipment.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

L -/- R/W -/- -/-

F -/- R/W -/- -/-

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.4.43 ALLEN-BRADLEY equipment ([AB Control/CompactLogix])

■1 Device setting dialog ([AB Control/CompactLogix])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of BOOL0[0]

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

7) [Switch to the tag list dialog] button

Item Reference

Device setting dialog ➟■1 Device setting dialog ([AB Control/CompactLogix])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([AB Control/CompactLogix])

➟■3 Availability of writing/reading data to/from bit devices ([AB Control/CompactLogix])

Specifications of word devices
➟■4 Monitoring-supported word devices ([AB Control/CompactLogix])

➟■5 Availability of writing/reading data to/from word devices ([AB Control/CompactLogix])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([AB Control/CompactLogix])

➟■7 Availability of writing/reading data to/from double-word devices ([AB Control/CompactLogix])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)
7)

BOOL0[0]

Device name
Device number
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You can open the tag list dialog to check the tags imported to GT Designer3.
➟6.1.8 ■4 Tag list dialog (RSLogix 5000 tag)

■2 Monitoring-supported bit devices ([AB Control/CompactLogix])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.43 ■3 Availability of writing/reading data to/from bit devices ([AB Control/CompactLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([AB Control/CompactLogix])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([AB Control/CompactLogix])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.43 ■5 Availability of writing/reading data to/from word devices ([AB Control/CompactLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

BOOL Bit data Decimal

BOOL(File No.):[(Element No.)]
Notation example: BOOL999[0]
• File No. (decimal): 0 to 999
• Element No. (decimal): 0 to 31999

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

BOOL R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

INT Word data Decimal

INT(File No.):[(Element No.)]
Notation example: INT999[0]
• File No. (decimal): 0 to 999
• Element No. (decimal): 0 to 999

○ ○
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■5 Availability of writing/reading data to/from word devices ([AB Control/CompactLogix])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Monitoring-supported double-word devices ([AB Control/CompactLogix])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.43 ■7 Availability of writing/reading data to/from double-word devices ([AB Control/CompactLogix])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([AB Control/
CompactLogix])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

INT R/W R/W -/- R/W

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DINT Double-word data Decimal

DINT(File No.):[(Element No.)]
Notation example: DINT999[0]
• File No. (decimal): 0 to 999
• Element No. (decimal): 0 to 999

× ×

REAL Floating point data Decimal

REAL(File No.):[(Element No.)]
Notation example: REAL999[0]
• File No. (decimal): 0 to 999
• Element No. (hexadecimal): 0 to 999

× ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

DINT -/- R/W -/- -/-

REAL -/- R/W -/- -/-
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12.4.44 ALLEN-BRADLEY equipment ([AB Control/CompactLogix(Tag)])

■1 Device setting dialog ([AB Control/CompactLogix(Tag)])
Set a device to be monitored.
In the device setting dialog, only GOT internal devices are settable.
For how to set AB native tags, refer to the following.

➟6.1.9 How to set AB native tags

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported devices ([AB Control/CompactLogix(Tag)])
When this communication driver is used, the AB native tags are usable in the device setting.
For details on usable AB native tags, refer to the following.

➟6.1.9 ■1 Usable AB native tags

Item Reference

Device setting dialog ➟■1 Device setting dialog ([AB Control/CompactLogix(Tag)])

Device specifications ➟■2 Monitoring-supported devices ([AB Control/CompactLogix(Tag)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)
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12.4.45 GE equipment ([GE Series 90])

■1 Device setting dialog ([GE Series 90])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I00001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
Specify a station number.
The setting range is [00] to [31].

■2 Monitoring-supported bit devices ([GE Series 90])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.45 ■3 Availability of writing/reading data to/from bit devices ([GE Series 90])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟12.4.45 ■1 Device setting dialog ([GE Series 90])

Specifications of bit devices
➟12.4.45 ■2 Monitoring-supported bit devices ([GE Series 90])

➟12.4.45 ■3 Availability of writing/reading data to/from bit devices ([GE Series 90])

Specifications of word devices
➟12.4.45 ■4 Monitoring-supported word devices ([GE Series 90])

➟12.4.45 ■5 Availability of writing/reading data to/from word devices ([GE Series 90])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

I00001

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([GE Series 90])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([GE Series 90])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.45 ■5 Availability of writing/reading data to/from word devices ([GE Series 90])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input Decimal 00001 to 12288 ○ ○

Q Output Decimal 00001 to 12288 ○ ○

M Internal Decimal 00001 to 12288 ○ ○

T Temporary Decimal 001 to 256 ○ ○

S System status Decimal 001 to 128 ○ ×

SA System status Decimal 001 to 128 ○ ○

SB System status Decimal 001 to 128 ○ ○

SC System status Decimal 001 to 128 ○ ○

G Global data Decimal 0001 to 7680 ○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- R/W -/- -/-

Q R/W -/- R/W -/- -/-

M R/W -/- R/W -/- -/-

T R/W -/- R/W -/- -/-

S R/- -/- R/- -/- -/-

SA R/W -/- R/W -/- -/-

SB R/W -/- R/W -/- -/-

SC R/W -/- R/W -/- -/-

G R/W -/- R/W -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

R System register Decimal 00001 to 32640 ○ ○

AI Analog input register Decimal 00001 to 32640 ○ ○

AQ Analog output register Decimal 00001 to 32640 ○ ○
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➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([GE Series 90])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

R R/W R/W -/- R/W

AI R/W R/W -/- R/W

AQ R/W R/W -/- R/W
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12.4.46 LS IS equipment ([LS Industrial Systems XGK])

Not available to GT2105-Q.

■1 Device setting dialog ([LS Industrial Systems XGK])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of P00000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.
The setting range is [1] to [239].

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.
The setting range is [1] to [64].

Item Reference

Device setting dialog ➟■1 Device setting dialog ([LS Industrial Systems XGK])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([LS Industrial Systems XGK])

➟■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems XGK])

Specifications of word devices
➟■4 Monitoring-supported word devices ([LS Industrial Systems XGK])

➟■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems XGK])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

P00000

Device name
Device number
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■2 Monitoring-supported bit devices ([LS Industrial Systems XGK])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.46 ■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems XGK])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems XGK])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

P I/O Relay
Decimal + 
hexadecim
al

P(Device)(Bit No.)
Notation example: P40950
The rightmost digit is a bit address.
• Device (decimal): 0 to 4095
• Bit No. (hexadecimal): 0 to F

○ ○

L Link relay
Decimal + 
hexadecim
al

L(Device)(Bit No.)
Notation example: L112630
The rightmost digit is a bit address.
• Device (decimal): 0 to 11263
• Bit No. (hexadecimal): 0 to F

○ ○

M Auxiliary relay
Decimal + 
hexadecim
al

M(Device)(Bit No.)
Notation example: M40950
The rightmost digit is a bit address.
• Device (decimal): 0 to 4095
• Bit No. (hexadecimal): 0 to F

○ ○

K Keep Relay
Decimal + 
hexadecim
al

K(Device)(Bit No.)
Notation example: K40950
The rightmost digit is a bit address.
• Device (decimal): 0 to 4095
• Bit No. (hexadecimal): 0 to F

○ ○

T Timer contact Decimal 0000 to 8191 ○
○
(Not usable as 
word data)

C Counter contact Decimal 0000 to 4095 ○
○
(Not usable as 
word data)

F Special relay
Decimal + 
hexadecim
al

F(Device)(Bit No.)
Notation example: F40950
The rightmost digit is a bit address.
• Device (decimal): 0 to 4095
• Bit No. (hexadecimal): 0 to F

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

P R/W -/- R/W -/- -/-

L R/W -/- R/W -/- -/-

M R/W -/- R/W -/- -/-

K R/W -/- R/W -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

F*1 R/W -/- R/W -/- -/-
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*1 Data cannot be written to F00000 to F1023F.

■4 Monitoring-supported word devices ([LS Industrial Systems XGK])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.46 ■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems XGK])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When the device type is the double-word (32 bits) type, set an even number for the special module number only.

■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems XGK])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

D Data Register Decimal 000000 to 524287 ○ ○

R File Register Decimal 00000 to 32767 ○ ○

ZR File Register Decimal 000000 to 524287 ○ ○

U*2 Analog Data Register
Hexadeci
mal + 
decimal

U(BaseNo.)(SlotNo.).(Special module No.)
Notation example: U7F.00
• BaseNo. (hexadecimal): 0 to 7
• SlotNo. (hexadecimal): 0 to F
• Special module No. (decimal): 00 to 31

○ ○

N Comm. Data Register Decimal 00000 to 21503 ○ ○

Z Index Register Decimal 000 to 255 ○ ○

T Timer current value Decimal 0000 to 8191 ○
○
(Not usable as bit 
data)

C Counter current value Decimal 0000 to 4095 ○
○
(Not usable as bit 
data)

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

D R/W R/W -/- R/W

R R/W R/W -/- R/W

ZR R/W R/W -/- R/W

U R/W R/W -/- R/W

N R/W R/W -/- R/W

Z R/W R/W -/- R/W

T R/W R/W -/- -/-

C R/W R/W -/- -/-
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12.4.47 LS IS equipment ([LS Industrial Systems MASTER-K])

■1 Device setting dialog ([LS Industrial Systems MASTER-K])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of P0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [0] to [31] (direct) or [100] to [115] (indirect).
For indirect specification of a station number, refer to the following.

➟(1) Indirect specification of a station number ([LS Industrial Systems MASTER-K])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([LS Industrial Systems MASTER-K])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([LS Industrial Systems MASTER-K])

➟■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems MASTER-K])

Specifications of word devices
➟■4 Monitoring-supported word devices ([LS Industrial Systems MASTER-K])

➟■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems MASTER-K])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

P0000

Device name
Device number
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(1) Indirect specification of a station number ([LS Industrial Systems MASTER-K])
When you specify any of 100 to 115 for the station number, the value of the corresponding GOT data register (GD10 to 
GD25) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

■2 Monitoring-supported bit devices ([LS Industrial Systems MASTER-K])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.47 ■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems MASTER-K])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Station No. GOT data register (GD) Setting range

100 GD10

[0] to [31]
Setting a value outside the above range causes a device range error.

101 GD11

: :

114 GD24

115 GD25

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

P I/O relay
Decimal + 
hexadecim
al

P(Device)(Bit No.)
Notation example: P0630
• Device (decimal): 000 to 063
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

L Link relay
Decimal + 
hexadecim
al

L(Device)(Bit No.)
Notation example: L0630
• Device (decimal): 000 to 063
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

M Auxiliary relay
Decimal + 
hexadecim
al

M(Device)(Bit No.)
Notation example: M1910
• Device (decimal): 000 to 191
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

K Keep relay
Decimal + 
hexadecim
al

K(Device)(Bit No.)
Notation example: K0310
• Device (decimal): 000 to 031
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)

T Timer (contact) Decimal 0 to 255 ○
○
(Not usable as 
word data)

C Counter (contact) Decimal 0 to 255 ○
○
(Not usable as 
word data)

F Special relay
Decimal + 
hexadecim
al

F(Device)(Bit No.)
Notation example: F0630
• Device (decimal): 000 to 063
• Bit No. (hexadecimal): 0 to F

○
○
(Not usable as 
word data)
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■3 Availability of writing/reading data to/from bit devices ([LS Industrial Systems MASTER-K])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([LS Industrial Systems MASTER-K])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.47 ■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems MASTER-K])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

P R/W -/- -/- -/- -/-

L R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

K R/W -/- -/- -/- -/-

T R/W -/- -/- -/- -/-

C R/W -/- -/- -/- -/-

F R/- -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T Timer (current value) Decimal 0 to 255 ○
○
(Not usable as bit 
data)

C Counter (current value) Decimal 0 to 255 ○
○
(Not usable as bit 
data)

D Data register Decimal 0 to 9999 ○
○
(Not usable as bit 
data)

F Special relay Decimal 000 to 063 ○
○
(Not usable as bit 
data)

P I/O relay Decimal 000 to 063 ○
○
(Not usable as bit 
data)

M Auxiliary relay Decimal 000 to 191 ○
○
(Not usable as bit 
data)

K Keep relay Decimal 000 to 031 ○
○
(Not usable as bit 
data)

L Link relay Decimal 000 to 063 ○
○
(Not usable as bit 
data)

S Step controller Decimal 0 to 99 ○
○
(Not usable as bit 
data)
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■5 Availability of writing/reading data to/from word devices ([LS Industrial Systems MASTER-
K])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

T R/W -/- -/- -/-

C R/W -/- -/- -/-

D R/W R/W -/- -/-

F R/- R/- -/- -/-

P R/W R/W -/- -/-

M R/W R/W -/- -/-

K R/W R/W -/- -/-

L R/W R/W -/- -/-

S R/W -/- -/- -/-
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12.4.48 MITSUBISHI INDIA equipment ([MEI Nexgenie])

■1 Device setting dialog ([MEI Nexgenie])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of IX0.0

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Station No.]
This item appears when [Selection] is selected for the monitor target specification.
The setting range is [1] to [247].

■2 Monitoring-supported bit devices ([MEI Nexgenie])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.48 ■3 Availability of writing/reading data to/from bit devices ([MEI Nexgenie])
For the formats of devices, refer to the following.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([MEI Nexgenie])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([MEI Nexgenie])

➟■3 Availability of writing/reading data to/from bit devices ([MEI Nexgenie])

Specifications of word devices
➟■4 Monitoring-supported word devices ([MEI Nexgenie])

➟■5 Availability of writing/reading data to/from word devices ([MEI Nexgenie])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

IX0.0

Device name
Device number
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➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([MEI Nexgenie])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([MEI Nexgenie])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.48 ■5 Availability of writing/reading data to/from word devices ([MEI Nexgenie])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IX Input Decimal + 
octal

IX(Byte address).(Bit address)
Notation example: IX255.0
• Byte address (decimal): 0 to 255
• Bit address (octal): 0 to 7

× ×

QX Output Decimal + 
octal

QX(Byte address).(Bit address)
Notation example: QX255.0
• Byte address (decimal): 0 to 255
• Bit address (octal): 0 to 7

× ×

MX Marker Decimal + 
octal

MX(Byte address).(Bit address)
Notation example: MX8191.0
• Byte address (decimal): 0 to 8191
• Bit address (octal): 0 to 7

× ×

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

IX R/- -/- -/- -/- -/-

QX R/- -/- -/- -/- -/-

MX R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IW Input Decimal 0 to 254 × ×

QW Output Decimal 0 to 254 × ×

MW Marker Decimal 0 to 32254 ○
○
(Not usable as bit 
data)

SW System Word Decimal 0 to 468 ○
○
(Not usable as bit 
data)
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■5 Availability of writing/reading data to/from word devices ([MEI Nexgenie])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 Some devices are read-only.
For the details, refer to the following manual.
➟Manual of the PLC used

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

IW R/- R/- -/- -/-

QW R/- R/- -/- -/-

MW R/W R/W -/- -/-

SW*1 R/W R/W -/- -/-
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12.4.49 SICK equipment ([SICK Flexi Soft])

The device specifications are the same as those of MELSEC-WS series.

■1 Device setting dialog ([SICK Flexi Soft])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I1.1

3) [Information]
Displays the setting range of each setting item according to the selected device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SICK Flexi Soft])

Specifications of bit devices
➟12.3.10 ■1 Monitoring-supported bit devices ([MELSEC-WS])

➟12.3.10 ■2 Availability of writing/reading data to/from bit devices ([MELSEC-WS])

Specifications of word devices
➟12.3.10 ■3 Monitoring-supported word devices ([MELSEC-WS])

➟12.3.10 ■4 Availability of writing/reading data to/from word devices ([MELSEC-WS])

Engineering software for SICK 
equipment and device 
representation of GT Designer3

➟12.3.10 ■5 Engineering software for MELSEC-WS and device representation of GT Designer3 
([MELSEC-WS])

Offset specifications ➟12.3.10 ■6 Offset specification ([MELSEC-WS])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

I1.1

Device name
Device number
12. APPENDICES
12.4 Device Range and Settings of Each Controller

12 - 687



12.4.50 SIEMENS equipment ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])

The item selectable for [Controller Type] in the [Controller Setting] window varies by GOT model.
• For GT27, GT25, GT23, and GS25

[SIEMENS S7-200]
• For GT21 and GS21

[SIEMENS S7-200(CN/SMART)]

■1 Device setting dialog ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of V00000

3) [Information]
Displays the setting range of each setting item according to the selected device.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])

Specifications of bit devices

➟■2 Monitoring-supported bit devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])

➟■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/
SMART)])

Specifications of word devices

➟■4 Monitoring-supported word devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])

➟■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/
SMART)])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])

➟■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-200] or [SIEMENS S7-
200(CN/SMART)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

V00000

Device name
Device number
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■2 Monitoring-supported bit devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.50 ■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7-200] or [SIEMENS S7-
200(CN/SMART)])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Writing is possible only while the programmable controller is running.

■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7-200] or [SIEMENS S7-
200(CN/SMART)])

The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, 
SoftGOT2000, and GS25 GT21 and GS21 Assignment to EG 

devices
Access using a 

client

I Input relay Decimal + 
octal

I(Byte address)(Bit address)
Notation example: I70

○
○
(Not usable as 
word data)• Byte address (decimal): 0 to 7

• Bit address (octal): 0 to 7

• Byte address (decimal): 00 to 
31

• Bit address (octal): 0 to 7

Q*2 Output relay Decimal + 
octal

Q(Byte address)(Bit address)
Notation example: Q70

○
○
(Not usable as 
word data)• Byte address (decimal): 0 to 7

• Bit address (octal): 0 to 7

• Byte address (decimal): 00 to 
31

• Bit address (octal): 0 to 7

M Bit memory Decimal + 
octal

M(Byte address)(Bit address)
Notation example: M310
• Byte address (decimal): 00 to 31
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

S Sequence control relay Decimal + 
octal

S(Byte address)(Bit address)
Notation example: S310
• Byte address (decimal): 00 to 31
• Bit address (octal): 0 to 7

○ ○

T Timer Decimal 0 to 255 × ×

C Counter Decimal 0 to 255 × ×

SM Special memory Decimal + 
octal

SM(Byte address)(Bit address)
Notation example: SM1940

○
○
(Not usable as 
word data)

• Byte address (decimal): 000 to 
194

• Bit address (octal): 0 to 7

• Byte address (decimal): 0000 
to 2047

• Bit address (octal): 0 to 7

V Variable memory Decimal + 
octal

V(Byte address)(Bit address)
Notation example: V51190

○
○
(Not usable as 
word data)

• Byte address (decimal): 0000 
to 5119

• Bit address (octal): 0 to 7

• Byte address (decimal): 
00000 to 20479

• Bit address (octal): 0 to 7

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/SMART)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.50 ■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-200] or [SIEMENS S7-
200(CN/SMART)])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When the device type is the word (16 bits) type, set an even number for the device number.

When the device type is the double-word (32 bits) type, set the device number in multiples of 4.
*3 Writing is possible only while the programmable controller is running.

M R/W -/- -/- -/- -/-

S R/W -/- -/- -/- -/-

T R/- -/- -/- -/- -/-

C R/- -/- -/- -/- -/-

SM R/W -/- -/- -/- -/-

V R/W -/- -/- -/- -/-

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, 
SoftGOT2000, and GS25 GT21 and GS21 Assignment to EG 

devices
Access using a 

client

T Timer Decimal 0 to 255 ○
○
(Not usable as bit 
data)

C Counter Decimal 0 to 255 ○
○
(Not usable as bit 
data)

VW*2 Variable memory Decimal 0 to 5118 0 to 20478 ○
○
(Not usable as bit 
data)

IW*2 Input relay Decimal 0 to 6 0 to 30 ○
○
(Not usable as bit 
data)

QW*2*

3 Output relay Decimal 0 to 6 0 to 30 ○
○
(Not usable as bit 
data)

MW*2 Bit memory Decimal 0 to 30 ○
○
(Not usable as bit 
data)

AIW*2 Analog input Decimal 0 to 30 0 to 110 × ×

AQW*

2*3 Analog output Decimal 0 to 30 0 to 110 ○
○
(Not usable as bit 
data)

SMW*

2 Special memory Decimal 0 to 192 0 to 2046 ○
○
(Not usable as bit 
data)

SW*2 Sequence control relay Decimal 0 to 30 ○
○
(Not usable as bit 
data)
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■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-200] or [SIEMENS 
S7-200(CN/SMART)])

The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Monitoring-supported double-word devices ([SIEMENS S7-200] or [SIEMENS S7-200(CN/
SMART)])

The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.50 ■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-200] or 
[SIEMENS S7-200(CN/SMART)])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-200] or 
[SIEMENS S7-200(CN/SMART)])

The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

T R/W -/- -/- -/-

C R/W -/- -/- -/-

VW R/W R/W -/- -/-

IW R/W R/W -/- -/-

QW R/W R/W -/- -/-

MW R/W R/W -/- -/-

AIW R/- R/- -/- -/-

AQW R/W R/W -/- -/-

SMW R/W R/W -/- -/-

SW R/W R/W -/- -/-

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, 
SoftGOT2000, and GS25 GT21 and GS21 Assignment to EG 

devices
Access using a 

client

HC High-speed counter Decimal 0 to 2 0 to 5 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

HC -/- R/- -/- -/-
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12.4.51 SIEMENS equipment ([SIEMENS S7-300/400])

■1 Device setting dialog ([SIEMENS S7-300/400])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller set for [Host Address] of the [Controller Setting] window is monitored.
• [Other]: The controller having the specified station number (MPI address) is monitored.

5) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SIEMENS S7-300/400])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SIEMENS S7-300/400])

➟■3 Availability of reading data to/from bit devices ([SIEMENS S7-300/400])

Specifications of word devices
➟■4 Monitoring-supported word devices ([SIEMENS S7-300/400])

➟■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-300/400])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([SIEMENS S7-300/400])

➟■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-300/400])

Notation of devices ➟■8 Notation of devices ([SIEMENS S7-300/400])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

I0000

Device name
Device number
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■2 Monitoring-supported bit devices ([SIEMENS S7-300/400])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.51 ■3 Availability of reading data to/from bit devices ([SIEMENS S7-300/400])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The notation of device setting is different between the SIEMENS PLC peripheral software and GOT.
For the notation of devices, refer to the following.

➟12.4.51 ■8 Notation of devices ([SIEMENS S7-300/400])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of reading data to/from bit devices ([SIEMENS S7-300/400])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use IW for I.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input relay Decimal + 
octal

I(Byte address)(Bit address)
Notation example: I5110
• Byte address (decimal): 000 to 511
• Bit address (octal): 0 to 7

○ ○

Q Output relay Decimal + 
octal

Q(Byte address)(Bit address)
Notation example: Q5110
• Byte address (decimal): 000 to 511
• Bit address (octal): 0 to 7

○ ○

M Bit memory Decimal + 
octal

M(Byte address)(Bit address)
Notation example: M20470
• Byte address (decimal): 0000 to 2047
• Bit address (octal): 0 to 7

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-
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■4 Monitoring-supported word devices ([SIEMENS S7-300/400])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.51 ■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-300/400])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 It is necessary to define the data block using a peripheral software or sequence program, before using this device.
*3 Continuous access across data blocks is not possible.
*4 When the device type is the word (16 bits) type, set an even number for the device number.

When the device type is the double-word (32 bits) type, set the device number in multiples of 4.
*5 Only one device can be set as the write destination.

Do not set this device as the write destination for a function to write data to consecutive devices such as the recipe function.

■5 Availability of writing/reading data to/from word devices ([SIEMENS S7-300/400])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use I for IW.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DB*2*3 Data register Decimal

DB(Data block No.).DBW(Device)
Notation example: DB4095.DBW0
• Data block No. (decimal): 1 to 4095
• Device (Data word No.) (decimal): 0 to 

65534 (Set an even number.)

○ ○

IW*4 Input relay Decimal 0 to 510 ○ ○

QW*4 Output relay Decimal 0 to 510 ○ ○

MW*4 Bit memory Decimal 0 to 2046 ○ ○

T*5 Timer (current value) Decimal 0 to 511 ○ ○

C Counter (current value) Decimal 0 to 511 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

DB R/W R/W -/- R/W

IW*1 R/W R/W -/- -/-

QW*1 R/W R/W -/- -/-

MW*1 R/W R/W -/- -/-

T R/W R/W -/- -/-

C R/W R/W -/- -/-
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■6 Monitoring-supported double-word devices ([SIEMENS S7-300/400])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.51 ■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-300/400])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 It is necessary to define the data block using a peripheral software or sequence program, before using this device.
*3 Continuous access across data blocks is not possible.

■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7-300/400])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■8 Notation of devices ([SIEMENS S7-300/400])
The notation of device setting is different between the SIEMENS PLC peripheral software and GOT.

(1) Notation of bit devices ([SIEMENS S7-300/400])

(2) Notation of bit-specified data register ([SIEMENS S7-300/400])

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DB*2*3 Data register Decimal

DB(Data block No.).DBD(Device)
Notation example: DB4095.DBD0
• Data block No. (decimal): 1 to 4095
• Device (Data word No.) (decimal): 0 to 

65532 (Set the number in multiples of 4.)

○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

DB R/W R/W -/- -/-

Notation in the GOT Notation in the PLC

Q0007 Q0.7

Notation in the GOT Notation in the PLC

DB1.DBW0.b0 DB1.DBX1.0

DB1.DBW0.b1 DB1.DBX1.1

: :

DB1.DBW0.b7 DB1.DBX1.7

DB1.DBW0.b8 DB1.DBX0.0

: :

DB1.DBW0.b15 DB1.DBX0.7

DB1.DBW2.b0 DB1.DBX3.0

: :

DB1.DBW2.b7 DB1.DBX3.7

DB1.DBW2.b8 DB1.DBX2.0

: :

DB1.DBW2.b15 DB1.DBX2.7

: :
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12.4.52 SIEMENS equipment ([SIEMENS S7(Ethernet)])

■1 Device setting dialog ([SIEMENS S7(Ethernet)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller set for [Host Address] of the [Controller Setting] window is monitored.
• [Other]: The controller having the specified station number is monitored.

5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SIEMENS S7(Ethernet)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SIEMENS S7(Ethernet)])

➟■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7(Ethernet)])

Specifications of word devices
➟■4 Monitoring-supported word devices ([SIEMENS S7(Ethernet)])

➟■5 Availability of writing/reading data to/from word devices ([SIEMENS S7(Ethernet)])

Specifications of double-word 
devices

➟■6 Monitoring-supported double-word devices ([SIEMENS S7(Ethernet)])

➟■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7(Ethernet)])

Notation of devices ➟12.4.51 ■8 Notation of devices ([SIEMENS S7-300/400])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

I0000

Device name
Device number
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■2 Monitoring-supported bit devices ([SIEMENS S7(Ethernet)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.52 ■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The notation of device setting is different between the SIEMENS PLC peripheral software and GOT.
For the notation of devices, refer to the following.

➟12.4.51 ■8 Notation of devices ([SIEMENS S7-300/400])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([SIEMENS S7(Ethernet)])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use IW for I.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([SIEMENS S7(Ethernet)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.52 ■5 Availability of writing/reading data to/from word devices ([SIEMENS S7(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input relay Decimal + 
octal

I(Byte address)(Bit address)
Notation example: I1270
• Byte address (decimal): 000 to 127
• Bit address (octal): 0 to 7

○ ○

Q Output relay Decimal + 
octal

Q(Byte address)(Bit address)
Notation example: Q1270
• Byte address (decimal): 000 to 127
• Bit address (octal): 0 to 7

○ ○

M Bit memory Decimal + 
octal

M(Byte address)(Bit address)
Notation example: M2550
• Byte address (decimal): 000 to 255
• Bit address (octal): 0 to 7

○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I R/W -/- -/- -/- -/-

Q R/W -/- -/- -/- -/-

M R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T*2 Timer (current value) Decimal 0 to 255 ○ ○

C Counter (current value) Decimal 0 to 255 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Only one device can be set as the write destination.

Do not set this device as the write destination for a function to write data to consecutive devices such as the recipe function.
*3 It is necessary to define the data block using a peripheral software or sequence program, before using this device.
*4 Continuous access across data blocks is not possible.
*5 When the device type is the word (16 bits) type, set an even number for the device number.

When the device type is the double-word (32 bits) type, set the device number in multiples of 4.

■5 Availability of writing/reading data to/from word devices ([SIEMENS S7(Ethernet)])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use I for IW.

■6 Monitoring-supported double-word devices ([SIEMENS S7(Ethernet)])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.52 ■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 It is necessary to define the data block using a peripheral software or sequence program, before using this device.

DB*3*4 Data register Decimal

DB(Data block No.).DBW(Device)
Notation example: DB255.DBW0
• Data block No. (decimal): 1 to 255
• Device (Data word No.) (decimal): 0 to 

2046 (Set an even number.)

○ ○

IW*5 Input relay Decimal 0 to 126 ○ ○

QW*5 Output relay Decimal 0 to 126 ○ ○

MW*5 Bit memory Decimal 0 to 254 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

T R/W -/- -/- -/-

C R/W -/- -/- -/-

DB R/W R/W -/- R/W

IW*1 R/W R/W -/- -/-

QW*1 R/W R/W -/- -/-

MW*1 R/W R/W -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

DB*2*3 Data register Decimal

DB(Data block No.).DBD(Device)
Notation example: DB255.DBD0
• Data block No. (decimal): 1 to 255
• Device (Data word No.) (decimal): 0 to 

2044 (Set the number in multiples of 4.)

○ ○
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*3 Continuous access across data blocks is not possible.

■7 Availability of writing/reading data to/from double-word devices ([SIEMENS S7(Ethernet)])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

DB R/W R/W -/- -/-
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12.4.53 SIEMENS equipment ([SIEMENS OP(Ethernet)])

Not available to GT2105-Q.

■1 Device setting dialog ([SIEMENS OP(Ethernet)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller set for [Host Address] of the [Controller Setting] window is monitored.
• [Other]: The controller having the specified station number is monitored.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SIEMENS OP(Ethernet)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SIEMENS OP(Ethernet)])

➟■3 Availability of writing/reading data to/from bit devices ([SIEMENS OP(Ethernet)])

Specifications of byte devices
➟■4 Monitoring-supported byte devices ([SIEMENS OP(Ethernet)])

➟■5 Availability of writing/reading data to/from byte devices ([SIEMENS OP(Ethernet)])

Specifications of word devices
➟■6 Monitoring-supported word devices ([SIEMENS OP(Ethernet)])

➟■7 Availability of writing/reading data to/from word devices ([SIEMENS OP(Ethernet)])

Specifications of double-word 
devices

➟■8 Monitoring-supported double-word devices ([SIEMENS OP(Ethernet)])

➟■9 Availability of writing/reading data to/from double-word devices ([SIEMENS OP(Ethernet)])

Offset specifications ➟■10 Offset specifications ([SIEMENS OP(Ethernet)])

Notation of devices ➟12.4.51 ■8 Notation of devices ([SIEMENS S7-300/400])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

4)

1)

5)

6)

I000000

Device name
Device number
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5) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

6) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

■2 Monitoring-supported bit devices ([SIEMENS OP(Ethernet)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.53 ■3 Availability of writing/reading data to/from bit devices ([SIEMENS OP(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
The notation of device setting is different between the SIEMENS PLC peripheral software and GOT.
For the notation of devices, refer to the following.

➟12.4.51 ■8 Notation of devices ([SIEMENS S7-300/400])
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Writing is possible only while the programmable controller is running.

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input relay Decimal + 
octal

I(Byte address)(Bit address)
Notation example: I655350
• Byte address (decimal): 00000 to 65535
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

Q*2 Output relay Decimal + 
octal

Q(Byte address)(Bit address)
Notation example: Q655350
• Byte address (decimal): 00000 to 65535
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

V Variable memory Decimal + 
octal

V(Byte address)(Bit address)
Notation example: V204790
• Byte address (decimal): 00000 to 20479
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

M Bit memory Decimal + 
octal

M(Byte address)(Bit address)
Notation example: M655350
• Byte address (decimal): 00000 to 65535
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

S Sequence control relay Decimal + 
octal

S(Byte address)(Bit address)
Notation example: S310
• Byte address (decimal): 00 to 31
• Bit address (octal): 0 to 7

○ ○

T Timer Decimal 0 to 255 ○ ×

C Counter Decimal 0 to 255 ○ ×

SM Special memory Decimal + 
octal

SM(Byte address)(Bit address)
Notation example: SM20470
• Byte address (decimal): 0000 to 2047
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)
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■3 Availability of writing/reading data to/from bit devices ([SIEMENS OP(Ethernet)])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use IW for I.

■4 Monitoring-supported byte devices ([SIEMENS OP(Ethernet)])
The following table shows monitoring-supported byte devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.53 ■5 Availability of writing/reading data to/from byte devices ([SIEMENS OP(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from byte devices ([SIEMENS OP(Ethernet)])
The following shows whether writing/reading data to/from byte devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Monitoring-supported word devices ([SIEMENS OP(Ethernet)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

I*1 R/W -/- -/- -/- -/-

Q*1 R/W -/- -/- -/- -/-

V*1 R/W -/- -/- -/- -/-

M*1 R/W -/- -/- -/- -/-

S*1 R/W -/- -/- -/- -/-

T R/- -/- -/- -/- -/-

C R/- -/- -/- -/- -/-

SM*1 R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

IB Input relay Decimal 0 to 65535 × ×

QB Output relay Decimal 0 to 65535 × ×

MB Bit memory Decimal 0 to 65535 × ×

Device name
Device type

Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of byte data

IB R/W -/- -/- -/- -/-

QB R/W -/- -/- -/- -/-

MB R/W -/- -/- -/- -/-
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➟12.4.53 ■7 Availability of writing/reading data to/from word devices ([SIEMENS OP(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Only one device can be set as the write destination.

Do not set this device as the write destination for a function to write data to consecutive devices such as the recipe function.
*3 It is necessary to define the data block using a peripheral software or sequence program, before using this device.
*4 Continuous access across data blocks is not possible.
*5 When the device type is the word (16 bits) type, set an even number for the device number.

When the device type is the double-word (32 bits) type, set the device number in multiples of 4.
*6 Writing is possible only while the programmable controller is running.

■7 Availability of writing/reading data to/from word devices ([SIEMENS OP(Ethernet)])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

T*2 Timer Decimal 0 to 65535 ○
○
(Not usable as bit 
data)

C Counter Decimal 0 to 65535 ○
○
(Not usable as bit 
data)

DB*3*4 Data register Decimal

DB(Data block No.).DBW(Device)
Notation example: DB65535.DBW0
• Data block No. (decimal): 1 to 65535
• Device (Data word No.) (decimal): 0 to 65534 

(Set an even number.)

○ ○

VW*5 Variable memory Decimal 0 to 20478 ○
○
(Not usable as bit 
data)

IW*5 Input relay Decimal 0 to 65534 ○
○
(Not usable as bit 
data)

QW*5*6 Output relay Decimal 0 to 65534 ○
○
(Not usable as bit 
data)

MW*5 Bit memory Decimal 0 to 65534 ○
○
(Not usable as bit 
data)

AIW*5 Analog input Decimal 0 to 110 ○ ×

AQW*5*6 Analog output Decimal 0 to 110 ○
○
(Not usable as bit 
data)

SMW*5 Special memory Decimal 0 to 2046 ○
○
(Not usable as bit 
data)

SW*5 Sequence control relay Decimal 0 to 30 ○
○
(Not usable as bit 
data)

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

T R/W R/W -/- -/-
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*1 To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use I for IW.

■8 Monitoring-supported double-word devices ([SIEMENS OP(Ethernet)])
The following table shows monitoring-supported double-word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.53 ■9 Availability of writing/reading data to/from double-word devices ([SIEMENS OP(Ethernet)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 It is necessary to define the data block using a peripheral software or sequence program, before using this device.
*3 Continuous access across data blocks is not possible.

■9 Availability of writing/reading data to/from double-word devices ([SIEMENS OP(Ethernet)])
The following shows whether writing/reading data to/from double-word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

C R/W R/W -/- -/-

DB R/W R/W -/- R/W

VW*1 R/W R/W -/- -/-

IW*1 R/W R/W -/- -/-

QW*1 R/W R/W -/- -/-

MW*1 R/W R/W -/- -/-

AIW R/- R/- -/- -/-

AQW R/W R/W -/- -/-

SMW*1 R/W R/W -/- -/-

SW*1 R/W R/W -/- -/-

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

ID Input relay Decimal 0 to 65532 (Set the number in multiples of 4.) × ×

QD Output relay Decimal 0 to 65532 (Set the number in multiples of 4.) × ×

MD Bit memory Decimal 0 to 65532 (Set the number in multiples of 4.) × ×

DB*2*3 Data register Decimal

DB(Data block No.).DBD(Device)
Notation example: DB4095.DBD0
• Data block No. (decimal): 1 to 4095
• Device (Data word No.) (decimal): 0 to 65532 

(Set the number in multiples of 4.)

○ ○

HC High-speed counter Decimal 0 to 3 × ×

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of double-word data

ID -/- R/W -/- -/-

QD -/- R/W -/- -/-

MD -/- R/W -/- -/-

DB R/W R/W -/- -/-

HC -/- R/- -/- -/-
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■10 Offset specifications ([SIEMENS OP(Ethernet)])
The following shows the offset specifications of each device when using the offset function.
For the notation and range of devices, refer to the following.

➟12.4.53 ■2 Monitoring-supported bit devices ([SIEMENS OP(Ethernet)])
12.4.53 ■4 Monitoring-supported byte devices ([SIEMENS OP(Ethernet)])
12.4.53 ■6 Monitoring-supported word devices ([SIEMENS OP(Ethernet)])
12.4.53 ■8 Monitoring-supported double-word devices ([SIEMENS OP(Ethernet)])

Device
Offset specifications

GT27, GT25, GT23, SoftGOT2000, and GS25 GT21 and GS21

Bit device

I

When the bit address is increased by 8 bits, the byte address is increased by 1 byte.
Example) Offset for I000000
When offset value is 10, I000012 is monitored.

Q

V

M

S

SM

T Example) Offset for T0
When offset value is 10, T10 is monitored.C

Byte device

IB
Example) Offset for IB0
When offset value is 10, IB10 is monitored.

QB

MB

Word device

T Example) Offset for T0
When offset value is 10, T10 is monitored.C

DB

The offset target is device number (data word number).
When a bit is specified, the bit is not supported for the bit number offset.

The offset value is specified as offset regardless of 
the data type.
Example) Offset for DB1.DBW0
When offset value is 10, DB1.DBW10 is monitored.

The offset value is changed and the value is specified 
for offset according to the data type.
Example) Offset for DB1.DBW0
When offset value is 10, DB1.DBW20 is monitored.

VW

The offset value is specified as offset regardless of 
the data type.
Example) Offset for VW0
When offset value is 10, VW10 is monitored.

The offset value is changed and the value is specified 
for offset according to the data type.
Example) Offset for VW0
When offset value is 10, VW20 are monitored.

IW

QW

MW

AIW

AQW

SMW

SW

Double-word device

ID The offset value is specified as offset regardless of 
the data type.
Example) Offset for ID0
When offset value is 10, DB1.DBW10 is monitored.

The offset value is changed and the value is specified 
for offset according to the data type.
Example) Offset for ID0
When offset value is 10, ID40 is monitored.

QD

MD

DB

The offset target is device number (data word number).

The offset value is specified as offset regardless of 
the data type.
Example) Offset for DB1.DBD0
When offset value is 10, DB1.DBD10 is monitored.

The offset value is changed and the value is specified 
for offset according to the data type.
Example) Offset for DB1.DBD0
When offset value is 10, DB1.DBD20 is monitored.

HC
Example) Offset for HC0
When offset value is 1, HC1 is monitored.
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12.4.54 CLPA ([CC-Link IE Field Network Basic])

■1 Device setting dialog ([CC-Link IE Field Network Basic])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of RX000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([CC-Link IE Field Network Basic])
The following table shows monitoring-supported bit devices.
The device range shown in this section indicates the maximum settable values in GT Designer3.
The range of devices that can actually be monitored depends on the number of stations occupied by remote stations that 
are set in the master station.
Before setting the device range, check the number of occupied stations that are assigned to the GOT.
If a non-existent device or a device number out of the range is set for an object, other objects for which correct devices 
are set may not be monitored.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.54 ■3 Availability of writing/reading data to/from bit devices ([CC-Link IE Field Network Basic])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([CC-Link IE Field Network Basic])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([CC-Link IE Field Network Basic])

➟■3 Availability of writing/reading data to/from bit devices ([CC-Link IE Field Network Basic])

Specifications of word devices
➟■4 Monitoring-supported word devices ([CC-Link IE Field Network Basic])

➟■5 Availability of writing/reading data to/from word devices ([CC-Link IE Field Network Basic])

Remote device setting of the GOT 
(remote station) ➟■6 Remote device setting of the GOT (remote station) ([CC-Link IE Field Network Basic])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

RX000

Device name
Device number
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For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([CC-Link IE Field Network Basic])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([CC-Link IE Field Network Basic])
The following table shows monitoring-supported word devices.
The device range shown in this section indicates the maximum settable values in GT Designer3.
The range of devices that can actually be monitored depends on the number of stations occupied by remote stations that 
are set in the master station.
Before setting the device range, check the number of occupied stations that are assigned to the GOT.
If a non-existent device or a device number out of the range is set for an object, other objects for which correct devices 
are set may not be monitored.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.54 ■5 Availability of writing/reading data to/from word devices ([CC-Link IE Field Network Basic])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

RX Remote input Hexadeci
mal 000 to 3FF ○ ○

RY Remote output Hexadeci
mal 000 to 3FF ○ ○

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

RX R/W -/- R/W R/W -/-

RY R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Ww Remote register Hexadeci
mal 000 to 1FF ○ ○

Wr Remote register Hexadeci
mal 000 to 1FF ○ ○
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■5 Availability of writing/reading data to/from word devices ([CC-Link IE Field Network Basic])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■6 Remote device setting of the GOT (remote station) ([CC-Link IE Field Network Basic])
The devices assigned to the GOT in the master station are allocated in the range starting from the first number in the 
GOT.
The following shows the examples of device assignment in the master station and in the GOT (remote station).
In the example of remote device assignment (RX/RY 1 station occupied), the remote devices assigned to the GOT 
(remote station) are RX100 to RX13F and RY100 to RY13F in the master station. Note that the corresponding remote 
devices in the GOT are RX000 to RX03F and RY000 to RY03F.

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

Ww R/W R/W -/- R/W

Wr R/W R/W -/- R/W

Example of remote device assignment 
RX/RY 1 station occupied

Example of remote device assignment 
Ww/Wr 1 station occupied

Master station
RX/RY

GOT (remote station)
RX/RY

Master station
Ww/Wr

GOT (remote station)
Ww/Wr

100

13F

000

03F 100

11F

000

01F

Example of remote device assignment 
RX/RY 2 station occupied

Example of remote device assignment 
Ww/Wr 2 station occupied

Master station
RX/RY

GOT (remote station)
RX/RY

Master station
Ww/Wr

GOT (remote station)
Ww/Wr

100

17F

000

07F

100

13F

000

03F
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12.4.55 CLPA ([SLMP])

■1 Device setting dialog ([SLMP])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of X000000

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [CPU No.]
Set the CPU number of the controller.

5) Station type specification
Select the station type (host or other) for the controller to be monitored.

• [Host]: The controller to be monitored is the host station.
• [Other]: The controller to be monitored is not the host station.

6) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.

7) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.

Item Reference

Device setting dialog ➟■1 Device setting dialog ([SLMP])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([SLMP])

➟■3 Availability of writing/reading data to/from bit devices ([SLMP])

Specifications of word devices
➟■4 Monitoring-supported word devices ([SLMP])

➟■5 Availability of writing/reading data to/from word devices ([SLMP])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

4)
5)

6)

7)

X000000

Device name
Device number
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■2 Monitoring-supported bit devices ([SLMP])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.55 ■3 Availability of writing/reading data to/from bit devices ([SLMP])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

X Input Hexadeci
mal 000000 to FFFFFF ○ ○

Y Output Hexadeci
mal 000000 to FFFFFF ○ ○

B Link relay Hexadeci
mal 000000 to FFFFFF ○ ○

M Internal relay Decimal 0 to 16777215 ○ ○

L Latch relay Decimal 0 to 16777215 ○ ○

F Annunciator Decimal 0 to 16777215 ○ ○

V Edge relay Decimal 0 to 16777215 ○ ○

TC Timer Coil Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

TS Timer contact Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

CC Counter Coil Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

CS Counter contact Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

STC Retentive timer Coil Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

STS Retentive timer Contact Decimal 0 to 16777215 ○
○
(Not usable as 
word data)

SB Link special relay Hexadeci
mal 000000 to FFFFFF ○ ○

SM Special relay Decimal 0 to 16777215 ○ ○

DX Direct access input Hexadeci
mal 000000 to FFFFFF ○ ○

DY Direct access output Hexadeci
mal 000000 to FFFFFF ○ ○

JnX*2 Link input (link direct device) Hexadeci
mal

J(Network No.)-X(Device)
Notation example: J1-X000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○

JnY*2 Link output (link direct device) Hexadeci
mal

J(Network No.)-Y(Device)
Notation example: J1-Y000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○

JnB*2 Link relay (link direct device) Hexadeci
mal

J(Network No.)-B(Device)
Notation example: J1-B000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Not available to GT21 and GS21.

■3 Availability of writing/reading data to/from bit devices ([SLMP])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([SLMP])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.55 ■5 Availability of writing/reading data to/from word devices ([SLMP])

JnSB*2 Link special relay (link direct 
device)

Hexadeci
mal

J(Network No.)-SB(Device)
Notation example: J1-SB000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

X R/W -/- R/W R/W -/-

Y R/W -/- R/W R/W -/-

B R/W -/- R/W R/W -/-

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

F R/W -/- R/W R/W -/-

V R/W -/- R/W R/W -/-

TC R/W -/- -/- -/- -/-

TS R/W -/- -/- -/- -/-

CC R/W -/- -/- -/- -/-

CS R/W -/- -/- -/- -/-

STC R/W -/- -/- -/- -/-

STS R/W -/- -/- -/- -/-

SB R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

DX R/W -/- R/W R/W -/-

DY R/W -/- R/W R/W -/-

JnX R/W -/- R/W R/W -/-

JnY R/W -/- R/W R/W -/-

JnB R/W -/- R/W R/W -/-

JnSB R/W -/- R/W R/W -/-
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For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

TN Timer (current value) Decimal 0 to 16777215 ○
○
(Not usable as bit 
data)

CN Counter (current value) Decimal 0 to 16777215 ○
○
(Not usable as bit 
data)

STN Retentive timer (current value) Decimal 0 to 16777215 ○
○
(Not usable as bit 
data)

D Data register Decimal 0 to 16777215 ○ ○

SD Special register Decimal 0 to 16777215 ○ ○

W Link register Hexadeci
mal 000000 to FFFFFF ○ ○

SW Link special register Hexadeci
mal 000000 to FFFFFF ○ ○

R File register (Block switching 
method) Decimal 0 to 16777215 ○ ○

ZR File register (Serial number 
access method)

Hexadeci
mal 000000 to FFFFFF ○ ○

Z Index register Decimal 0 to 16777215 ○ ○

G*2 Module access device (buffer 
memory) Decimal

U(Unit No.)-G(Device)
Notation example: UFF-G0
• Unit No.(hexadecimal): 00 to FF
• Device (decimal): 0 to 16777215

○ ○

U3E0G*2 CPU buffer memory Decimal
U3E0-G(Device)
Notation example: U3E0-G0
• Device (decimal): 0 to 16777215

○ ○

U3E1G*2 CPU buffer memory Decimal
U3E1-G(Device)
Notation example: U3E1-G0
• Device (decimal): 0 to 16777215

○ ○

U3E2G*2 CPU buffer memory Decimal
U3E2-G(Device)
Notation example: U3E2-G0
• Device (decimal): 0 to 16777215

○ ○

U3E3G*2 CPU buffer memory Decimal
U3E3-G (Device)
Notation example: U3E3-G0
• Device (decimal): 0 to 16777215

○ ○

U3E0HG*

2

Fixed-cycle area of the CPU buffer 
memory (multiple CPU high speed 
transmission memory)

Decimal
U3E0-HG(Device)
Notation example: U3E0-HG0
• Device (decimal): 0 to 16777215

○ ○

U3E1HG*

2

Fixed-cycle area of the CPU buffer 
memory (multiple CPU high speed 
transmission memory)

Decimal
U3E1-HG(Device)
Notation example: U3E1-HG0
• Device (decimal): 0 to 16777215

○ ○

U3E2HG*

2

Fixed-cycle area of the CPU buffer 
memory (multiple CPU high speed 
transmission memory)

Decimal
U3E2-HG(Device)
Notation example: U3E2-HG0
• Device (decimal): 0 to 16777215

○ ○

U3E3HG*

2

Fixed-cycle area of the CPU buffer 
memory (multiple CPU high speed 
transmission memory)

Decimal
U3E3-HG(Device)
Notation example: U3E3-HG0
• Device (decimal): 0 to 16777215

○ ○

JnW*2 Link register (link direct device) Hexadeci
mal

J(Network No.)-W(Device)
Notation example: J1-W000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 Not available to GT21 and GS21.

■5 Availability of writing/reading data to/from word devices ([SLMP])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

*1 When bit specification of word device is performed, the GOT reads the value from a device and then write a value to the 
device.
Do not change the device value with a sequence program until the GOT completes writing a value to the device.

JnSW*2 Link special register (link direct 
device)

Hexadeci
mal

J(Network No.)-SW(Device)
Notation example: J1-SW000000
• Network No. (decimal): 1 to 239
• Device (hexadecimal): 000000 to FFFFFF

○ ○

RD*2 Refresh data register Decimal 0 to 4294967295 ○ ○

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

TN R/W R/W -/- -/-

CN R/W R/W -/- -/-

STN R/W R/W -/- -/-

D*1 R/W R/W -/- R/W

SD*1 R/W R/W -/- R/W

W*1 R/W R/W -/- R/W

SW*1 R/W R/W -/- R/W

R*1 R/W R/W -/- R/W

ZR*1 R/W R/W -/- R/W

Z R/W R/W -/- -/-

G R/W R/W -/- R/W

U3E0G R/W R/W -/- R/W

U3E1G R/W R/W -/- R/W

U3E2G R/W R/W -/- R/W

U3E3G R/W R/W -/- R/W

U3E0HG R/W R/W -/- R/W

U3E1HG R/W R/W -/- R/W

U3E2HG R/W R/W -/- R/W

U3E3HG R/W R/W -/- R/W

JnW R/W R/W -/- R/W

JnSW R/W R/W -/- R/W

RD R/W R/W -/- R/W
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12.4.56 MODBUS ([MODBUS Slave(GOT:Master)])

■1 Device setting dialog ([MODBUS Slave(GOT:Master)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of 100001

3) [Information]
Displays the setting range of each setting item according to the selected device.

4) [Network Setting]
The setting depends on the connection type.

➟(1) Network setting for the MODBUS/RTU connection ([MODBUS Slave(GOT:Master)])
(3) Network setting for the MODBUS/TCP connection ([MODBUS Slave(GOT:Master)])

Item Reference

Device setting dialog ➟■1 Device setting dialog ([MODBUS Slave(GOT:Master)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([MODBUS Slave(GOT:Master)])

➟■3 Availability of writing/reading data to/from bit devices ([MODBUS Slave(GOT:Master)])

Specifications of word devices
➟■4 Monitoring-supported word devices ([MODBUS Slave(GOT:Master)])

➟■5 Availability of writing/reading data to/from word devices ([MODBUS Slave(GOT:Master)])

Notation of devices ➟■6 Notation of devices ([MODBUS Slave(GOT:Master)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

4)

100001

Device name
Device number
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(1) Network setting for the MODBUS/RTU connection ([MODBUS Slave(GOT:Master)])

1) Monitor target specification
Set the monitoring target of the set device.

2) [Network No.]
This item appears when [Other] is selected for the station type.
For the MODBUS/RTU connection, set 1.

3) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.
The setting range is [1] to [247] (direct) or [248] to [254] (indirect).
For indirect specification of a station number, refer to the following.

➟(2) Indirect specification of a station number for the MODBUS/RTU master connection ([MODBUS 
Slave(GOT:Master)])

(2) Indirect specification of a station number for the MODBUS/RTU master connection ([MODBUS 
Slave(GOT:Master)])
When you specify any of 248 to 254 for the station number, the value of the corresponding GOT data register (GD10 to 
GD16) is used as the station number.
The following shows the correspondence between station number setting values and GOT data registers (GD).

Item Description

[All]

Select this item when writing data to all the connected controllers.
During monitoring, the controller set for [Host Address] of the [Controller Setting] window is monitored.
When data is input from a numerical input object, the data is written to all the connected controllers. 
When no data is input, the controller set for [Host Address] is monitored.

[Host] Select this item when monitoring the controller set as the host station.

[Other] Select this item when monitoring the controller that has the specified station number.

1)
2)

3)

Station No. GOT data register (GD) Setting range

248 GD10

[0] to [255]
Setting a value outside the above range causes a device range error.
When "0" is set, "All station specification (broadcast)" is specified.
When "255" is set, the host station is specified.

249 GD11

: :

253 GD15

254 GD16
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(3) Network setting for the MODBUS/TCP connection ([MODBUS Slave(GOT:Master)])

1) Monitor target specification
Set the monitoring target of the set device.

2) [Network No.]
This item appears when [Other] is selected for the station type.
Specify a network number.
The setting range is [1] to [239].

3) [Station No.]
This item appears when [Other] is selected for the station type.
Specify a station number.
The setting range is [1] to [247].

■2 Monitoring-supported bit devices ([MODBUS Slave(GOT:Master)])
The following table shows monitoring-supported bit devices.
The device range of MODBUS equipment varies by model.
When a model whose device range is not a specified using a multiple of 16 is used, monitoring to the maximum within 
the range may not be possible.
In this case, the device range is up to the number divisible by 16.
Example) For a model whose coil device range is from 0 to 9999
The range that can be actually monitored is from 0 to 9984.

To check whether writing/reading data to/from each device is available, refer to the following.
➟12.4.56 ■3 Availability of writing/reading data to/from bit devices ([MODBUS Slave(GOT:Master)])

For the formats of devices, refer to the following.
➟6.1.1 Formats of devices, labels, and tags

○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Item Description

[All] Not available to the MODBUS/TCP connection.

[Host] Select this item when monitoring the controller set as the host station.

[Other] Select this item when monitoring the controller that has the specified station number.

1)
2)

3)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

1 Input relay Decimal 00001 to 65536 ○
○
(Not usable as 
word data)

0 Coils Decimal 00001 to 65536 ○
○
(Not usable as 
word data)
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■3 Availability of writing/reading data to/from bit devices ([MODBUS Slave(GOT:Master)])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([MODBUS Slave(GOT:Master)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.56 ■5 Availability of writing/reading data to/from word devices ([MODBUS Slave(GOT:Master)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([MODBUS Slave(GOT:Master)])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

1 R/- -/- -/- -/- -/-

0 R/W -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

4 Holding register Decimal 00001 to 65536 ○
○
(Not usable as bit 
data)

3 Input register Decimal 00001 to 65536 ○
○
(Not usable as bit 
data)

6 Extension file register Decimal

(File No.)-6(Device)
Notation example: 418-600000
• File No. (decimal): 0 to 418
• Device (decimal): 00000 to 09999

○
○
(Not usable as bit 
data)

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

4 R/W R/W -/- R/W

3 R/- R/- -/- R/-

6 R/W R/W -/- R/W
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■6 Notation of devices ([MODBUS Slave(GOT:Master)])
The notation of addresses and that of devices differ between the MODBUS/RTU communication protocol and GT 
Designer3.
Set the devices using the notation used in GT Designer3.

Example) Monitoring the holding register 1234 (hexadecimal)
Set 404661 in GT Designer3.

Notation in the communication protocol Notation in the GOT

Device name Address (hexadecimal) Device name Device No. (decimal)

Coils 0000 to FFFF 0 00001 to 65536

Input relay 0000 to FFFF 1 00001 to 65536

Input register 0000 to FFFF 3 00001 to 65536

Holding register 0000 to FFFF 4 00001 to 65536

Extension file register 0000 to 270F 6 00000 to 09999

Notation in the communication protocol Holding register 1234 (hexadecimal)

Device name: 4 Device No.: 04660 (decimal) + 1

Notation in GT Designer3 404661 (decimal)
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12.4.57 MODBUS ([MODBUS Master(GOT:Slave)])

■1 Device setting dialog ([MODBUS Master(GOT:Slave)])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of 100001

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([MODBUS Master(GOT:Slave)])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.57 ■3 Availability of writing/reading data to/from bit devices ([MODBUS Master(GOT:Slave)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Item Reference

Device setting dialog ➟■1 Device setting dialog ([MODBUS Master(GOT:Slave)])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([MODBUS Master(GOT:Slave)])

➟■3 Availability of writing/reading data to/from bit devices ([MODBUS Master(GOT:Slave)])

Specifications of word devices
➟■4 Monitoring-supported word devices ([MODBUS Master(GOT:Slave)])

➟■5 Availability of writing/reading data to/from word devices ([MODBUS Master(GOT:Slave)])

Notation of devices ➟12.4.56 ■6 Notation of devices ([MODBUS Slave(GOT:Master)])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

100001

Device name
Device number

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, 
SoftGOT2000, and GS25 GT21 and GS21 Assignment to EG 

devices
Access using a 

client

1 Input relay Decimal 00001 to 65536 00001 to 10000 ○ ○

0 Coils Decimal 00001 to 65536 00001 to 10000 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([MODBUS Master(GOT:Slave)])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([MODBUS Master(GOT:Slave)])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.57 ■5 Availability of writing/reading data to/from word devices ([MODBUS Master(GOT:Slave)])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([MODBUS Master(GOT:Slave)])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

1 R/W -/- R/W R/W -/-

0 R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion

Setting range Specifications of EG devices*1

GT27, GT25, GT23, 
SoftGOT2000, and GS25 GT21 and GS21 Assignment to EG 

devices
Access using a 

client

4 Holding register Decimal 00001 to 65536 00001 to 10000 ○ ○

3 Input register Decimal 00001 to 65536 00001 to 10000 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

4 R/W R/W -/- R/W

3 R/W R/W -/- R/W
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12.4.58 ODVA ([DeviceNet])

■1 Device setting dialog ([DeviceNet])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of I0

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported word devices ([DeviceNet])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.58 ■3 Availability of writing/reading data to/from word devices ([DeviceNet])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

Item Reference

Device setting dialog ➟■1 Device setting dialog ([DeviceNet])

Specifications of word devices
➟■2 Monitoring-supported word devices ([DeviceNet])

➟■3 Availability of writing/reading data to/from word devices ([DeviceNet])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

I0

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

I Input Decimal 0 to 127 ○ ○

O Output Decimal 0 to 127 ○ ○
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■3 Availability of writing/reading data to/from word devices ([DeviceNet])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

I R/W R/W -/- R/W

O R/- R/- -/- R/-
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12.4.59 OPC ([OPC UA])

■1 Device setting dialog ([OPC UA])
Set a device to be monitored.
In the device setting dialog, only GOT internal devices are settable.
For information on setting OPC UA tags, refer to the following.

➟6.1.10 How to set OPC UA tags

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported devices ([OPC UA])
To monitor an OPC UA server, use OPC UA tags.
For the usable OPC UA tags, refer to the following.

➟6.1.10 ■1 Usable OPC UA tags

Item Reference

Device setting dialog ➟■1 Device setting dialog ([OPC UA])

Device specifications ➟■2 Monitoring-supported devices ([OPC UA])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)
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12.4.60 PROFIBUS ([PROFIBUS DP])

■1 Device setting dialog ([PROFIBUS DP])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of PI0000

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([PROFIBUS DP])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.60 ■3 Availability of writing/reading data to/from bit devices ([PROFIBUS DP])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Item Reference

Device setting dialog ➟■1 Device setting dialog ([PROFIBUS DP])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([PROFIBUS DP])

➟■3 Availability of writing/reading data to/from bit devices ([PROFIBUS DP])

Specifications of word devices
➟■4 Monitoring-supported word devices ([PROFIBUS DP])

➟■5 Availability of writing/reading data to/from word devices ([PROFIBUS DP])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

PI0000

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PI Input relay Decimal + 
octal

PI(Byte address)(Bit address)
Notation example: PI2430
• Byte address (decimal): 000 to 243
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([PROFIBUS DP])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
To use the device as word data, use the word device that has the same device name appended with "W".
Example) Use PIW for PI.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([PROFIBUS DP])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.60 ■5 Availability of writing/reading data to/from word devices ([PROFIBUS DP])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)
*2 When the device type is the word (16 bits) type, set an even number for the device number.

When the device type is the double-word (32 bits) type, set the device number in multiples of 4.

PQ Output relay Decimal + 
octal

PQ(Byte address)(Bit address)
Notation example: PQ2430
• Byte address (decimal): 000 to 243
• Bit address (octal): 0 to 7

○
○
(Not usable as 
word data)

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

PI R/W -/- -/- -/- -/-

PQ R/- -/- -/- -/- -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

PIW*2 Input relay Decimal 0 to 242 ○
○
(Not usable as bit 
data)

PQW*2 Output relay Decimal 0 to 242 ○
○
(Not usable as bit 
data)
12. APPENDICES
12.4 Device Range and Settings of Each Controller

12 - 725



■5 Availability of writing/reading data to/from word devices ([PROFIBUS DP])
The following shows whether writing/reading data to/from word devices is available by device type.
To use the device as bit data, use the bit device that has the same device name without "W".
Example) Use PI for PIW.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

PIW R/W R/W -/- -/-

PQW R/- R/- -/- -/-
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12.4.61 Microcomputer ([Computer])

■1 Device setting dialog ([Computer])
Set a device to be monitored.

1) Title
Data type and channel number of the device to be set

2) [Device]
Set the device name and device number.
If a bit number needs to be specified, the setting item is displayed.
Example) Setting of M0

3) [Information]
Displays the setting range of each setting item according to the selected device.

■2 Monitoring-supported bit devices ([Computer])
The following table shows monitoring-supported bit devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.61 ■3 Availability of writing/reading data to/from bit devices ([Computer])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

Item Reference

Device setting dialog ➟■1 Device setting dialog ([Computer])

Specifications of bit devices
➟■2 Monitoring-supported bit devices ([Computer])

➟■3 Availability of writing/reading data to/from bit devices ([Computer])

Specifications of word devices
➟■4 Monitoring-supported word devices ([Computer])

➟■5 Availability of writing/reading data to/from word devices ([Computer])

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

2) 3)

1)

M0

Device name
Device number

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

M Internal relay Decimal 0 to 2047 ○ ○

L Latch relay Decimal 0 to 2047 ○ ○

SM Special relay Decimal 0 to 63 ○ ○
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*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■3 Availability of writing/reading data to/from bit devices ([Computer])
The following shows whether writing/reading data to/from bit devices is available by device type.
When the device type is other than the bit type, set the device No. in multiples of 16.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

■4 Monitoring-supported word devices ([Computer])
The following table shows monitoring-supported word devices.
To check whether writing/reading data to/from each device is available, refer to the following.

➟12.4.61 ■5 Availability of writing/reading data to/from word devices ([Computer])
For the formats of devices, refer to the following.

➟6.1.1 Formats of devices, labels, and tags
○: Available
×: Not available

*1 For the devices assigned to EG devices (gateway devices) and the compatible clients, refer to the following.

➟10.13 Monitoring a Controller through a GOT (Server/Client Function)

■5 Availability of writing/reading data to/from word devices ([Computer])
The following shows whether writing/reading data to/from word devices is available by device type.
R/W: Both read and write
R/-: Read only
-/W: Write only
-/-: No read/write access

Device name
Device type

Bit Byte (8 bits) Word (16 bits) Double-word (32 bits) Quad-word (64 bits)

M R/W -/- R/W R/W -/-

L R/W -/- R/W R/W -/-

SM R/W -/- R/W R/W -/-

Device name
Device No. 
representa

tion
Setting range

Specifications of EG devices*1

Assignment to EG 
devices

Access using a 
client

D Data register Decimal 0 to 4095 ○ ○

SD Special register Decimal 0 to 15 ○ ○

R File register Decimal 0 to 4095 ○ ○

Device name
Device type

Word (16 bits) Double-word (32 bits) Quad-word (64 bits) Bit of word data

D R/W R/W -/- R/W

SD R/W R/W -/- R/W

R R/W R/W -/- R/W
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12.5 [Unit Type] in [Connected Ethernet Controller Setting]
In the [Controller Setting] window, if you select an Ethernet interface, [Connected Ethernet Controller Setting] appears.
Register the controller to be connected to the GOT by Ethernet.
Set [Unit Type] according to the connected controller or communication module.

The selectable items for [Unit Type] vary according to the selection for [Controller Type].
For the selectable items for each controller type, refer to the following.

➟12.5.1 Selectable items for [Unit Type]

For the correspondence between the selectable items for [Unit Type] and the controllers or communication modules, refer 
to the following.

➟12.5.2 Correspondence between the selection for [Unit Type] and the equipment used

12.5.1 Selectable items for [Unit Type]

The selectable items for [Unit Type] in [Connected Ethernet Controller Setting] vary according to the selection for 
[Controller Type].

➟■1 Selectable items for connection to Mitsubishi Electric equipment
■2 Selectable items for connection to non-Mitsubishi Electric equipment

Ethernet

Station No.: 1
Controller: R08CPU (Built-in Ethernet port)
IP address: 192.168.3.39

Station No.: 2
Controller: L02CPU (Built-in Ethernet port)
IP address: 192.168.3.40
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■1 Selectable items for connection to Mitsubishi Electric equipment
The following shows the selectable items when [MITSUBISHI ELECTRIC] is selected for [manufacturer].

[Controller Type] (When [Ethernet: Multi] is set to [I/F]) [Unit Type] in [Connected Ethernet Controller Setting]

[MELSEC iQ-R, RnMT/NC/RT, CR800-D]*1 [RCPU]
[RnCCPU/RnWCPU]

[RnNCCPU]*1

[LHCPU]
[FX5CPU]
[QnUD(P)V/QnUDE(H)]

[Q17nNC]*1

[QnD(H)CCPU]
[RJ71GN11-T2/RD78G(H)]
[RJ71EN71]
[FX5-CCLGN-MS/FX5-nSSC-G]
[FX5-ENET]
[QJ71E71/LJ71E71]
[LCPU]
[NZ2GF-ETB]

[AJ71QE71]*1

[AJ71E71]*1

[CR800]
[CRnD-700]
[Q17nDSR]

[MELSEC iQ-R, RnMT/RT, CR800-D]*2*3

[MELSEC iQ-L] [RCPU]
[RnCCPU/RnWCPU]
[RnNCCPU]*1

[LHCPU]
[FX5CPU]
[QnUD(P)V/QnUDE(H)]

[Q17nNC]*1

[QnD(H)CCPU]
[RJ71GN11-T2/RD78G(H)]
[RJ71EN71]
[FX5-CCLGN-MS/FX5-nSSC-G]
[FX5-ENET]
[QJ71E71/LJ71E71]
[LCPU]
[NZ2GF-ETB]
[AJ71QE71]*1

[AJ71E71]*1

[CR800]
[CRnD-700]
[Q17nDSR]

[MELSEC iQ-F]

[MELSEC-Q/QS, Q17nD/M/NC/DR/DSR, CRnD-700]*1

[MELSEC-Q, Q17nD/M/DR/DSR, CRnD-700]*2*3

[MELSEC-QnA, MELDAS C6*]*1

[MELSEC-L]

[MELSEC-A]*1

[MELSEC-FX] [FX]

[MELIPC]

[MELIPC]
[RCPU]
[RnCCPU/RnWCPU]
[RnNCCPU]*1

[LHCPU]
[FX5CPU]
[QnUD(P)V/QnUDE(H)]

[Q17nNC]*1

[QnD(H)CCPU]
[RJ71GN11-T2/RD78G(H)]
[RJ71EN71]
[FX5-CCLGN-MS/FX5-nSSC-G]
[FX5-ENET]
[QJ71E71/LJ71E71]
[LCPU]
[NZ2GF-ETB]
[AJ71QE71]*1

[AJ71E71]*1

[CR800]
[CRnD-700]
[Q17nDSR]
12 - 730 12. APPENDICES
12.5 [Unit Type] in [Connected Ethernet Controller Setting]



A
PP

EN
D

IC
ES

12
*1 Not available to GT21 and GS21.
*2 Not available to GT SoftGOT2000.
*3 Not available to GT27, GT25, GT23, and GS25.

■2 Selectable items for connection to non-Mitsubishi Electric equipment
The following shows the selectable items when any option other than [MITSUBISHI ELECTRIC] is selected for 
[manufacturer].

*1 Not available to GT21 and GS21.
*2 Not available to GT SoftGOT2000.

[MELSERVO-JE-*C]*2 [MR-JE-C]

[MELSERVO-J5(W)-*G(-RJ), -JET-*G] [MR-J5(D)-G/MR-JET-G]

[FREQROL 800]*2
[FREQROL]

[FREQROL 800/E700NE(Batch monitor)]

[Controller Type] (When [Ethernet: Multi] is set to [I/F]) [Unit Type] in [Connected Ethernet Controller Setting]

[Controller Type] (When [Ethernet: Multi] is set to [I/F]) [Unit Type] in [Connected Ethernet Controller Setting]

[OMRON SYSMAC] [OMRON]

[OMRON NJ/NX]
[OMRON NJ/NX]
[CJ1W-EIP21]

[KEYENCE KV-700/1000/3000/5000/7000/8000] [KEYENCE]

[TOSHIBA Unified Controller nv]*1 [TOSHIBA]

[HITACHI IES EHV]*1*2 [HITACHI IES]

[HITACHI S10VE] [HITACHI]

[FUJI MICREX-SX SPH]*2 [FUJI]

[YASKAWA MP2000/MP900/CP9200SH]
[YASKAWA]

[YASKAWA MP3000]

[YASKAWA Robot Controller] [YASKAWA(YRC1000)]

[YOKOGAWA STARDOM/FA500/FA-M3]*1 [YOKOGAWA]

[AB MicroLogix]*1*2 [AB(MicroLogix)]

[AB Control/CompactLogix]*2 [AB]

[AB Control/CompactLogix(Tag)]*1 [AB(Tag)]

[LS Industrial Systems XGK]
[XGK-CPU]
[XGL-EFMT(B)]

[SIEMENS S7(Ethernet)]*1 [SIEMENS S7]

[SIEMENS OP(Ethernet)]

[S7-200 OP]
[S7-200 SMART OP]
[S7-300/400 OP]
[S7-1200 OP]
[S7-1500 OP]

[SLMP] [SLMP]

[MODBUS Slave(GOT:Master)]
[MODBUS/TCP]
[MODBUS/TCP(unit ID fixed)]
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12.5.2 Correspondence between the selection for [Unit Type] and the equipment used

Set [Unit Type] according to the connected controller or communication module
➟■1 When connecting a Mitsubishi Electric equipment
■2 When connecting a non-Mitsubishi Electric equipment

■1 When connecting a Mitsubishi Electric equipment
Controller or communication module [Unit Type] on GT Designer3

RCPU

RnCPU *1

Built-in Ethernet port [RCPU]

Ethernet module [RJ71EN71]

CC-Link IE TSN master/local module

[RJ71GN11-T2/RD78G(H)]Motion module

CC-Link IE TSN Plus master/local 
module

Process CPU *1

SIL2 Process CPU *1
Built-in Ethernet port [RCPU]

Ethernet module [RJ71EN71]

Safety CPU *1

Built-in Ethernet port [RCPU]

Ethernet module [RJ71EN71]

Motion module [RJ71GN11-T2/RD78G(H)]

RnENCPU *1

Built-in Ethernet port (CPU P1) [RCPU]

Built-in Ethernet port (P1)
[RJ71EN71]

Ethernet module

CC-Link IE TSN master/local module

[RJ71GN11-T2/RD78G(H)]Motion module

CC-Link IE TSN Plus master/local 
module

C Controller module *1

Built-in Ethernet port [RnCCPU/RnWCPU]

CC-Link IE TSN master/local module
[RJ71GN11-T2/RD78G(H)]

Motion module

MELSECWinCPU *1
Built-in Ethernet port [RnCCPU/RnWCPU]

CC-Link IE TSN master/local module [RJ71GN11-T2/RD78G(H)]

Motion CPU (MELSEC iQ-R series)
Built-in Ethernet port [RCPU]

Ethernet module [RJ71EN71]

CNC C80
Display I/F [RnNCCPU]

Ethernet module [RJ71EN71]

Robot controller (MELSEC iQ-R 
series)

CR800-R(R16RTCPU)

Via a Control CPU [RCPU]

Display I/F [CR800]

Ethernet module [RJ71EN71]

CR800-D [CR800]

LHCPU Built-in Ethernet port [LHCPU]

FX5CPU

Built-in Ethernet port [FX5CPU]

Ethernet module [FX5-ENET]

CC-Link IE TSN master/local module
[FX5-CCLGN-MS/FX5-nSSC-G]

Motion module

QCPU

Basic model QCPU *1

High Performance model QCPU *1

Process CPU *1

Redundant CPU *1

Universal model QCPU *1

Built-in Ethernet port [QnUD(P)V/QnUDE(H)]

Ethernet module [QJ71E71/LJ71E71]

C Controller module *1 [QnD(H)CCPU]
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MELSEC-QS [QJ71E71/LJ71E71]

Motion CPU (Q series)
PERIPHERAL I/F [QnUD(P)V/QnUDE(H)]

Ethernet module [QJ71E71/LJ71E71]

CNC C70
Display I/F [Q17nNC]

Ethernet module [QJ71E71/LJ71E71]

Robot controller (Q series)

CRnQ-700(Q172DRCPU)
CR750-Q(Q172DRCPU)
CR751-Q(Q172DRCPU)

Via a Control CPU [QnUD(P)V/QnUDE(H)]

Ethernet module [QJ71E71/LJ71E71]

CR800-Q(Q172DSRCPU)

Via a Control CPU [QnUD(P)V/QnUDE(H)]

Built-in Ethernet port [Q17nDSR]

Ethernet module [QJ71E71/LJ71E71]

CRnD-700
CR750-D
CR751-D

[CRnD-700]

LCPU
Built-in Ethernet port [LCPU]

Ethernet module [QJ71E71/LJ71E71]

CC-Link IE Field Network Ethernet adapter module [NZ2GF-ETB]

MELSEC-QnA [AJ71QE71]

MELSEC-A

[AJ71E71]MELSEC-Q (A mode)

Motion CPU (A series)

FXCPU [FX]

MELIPC [MELIPC]

MR-JE-*C [MR-JE-C]

MR-J5-□G(-RJ), MR-J5W-□G, MR-JET-□G, MR-J5D□-G [MR-J5(D)-G/MR-JET-G]

FR-E7□0-NE

[FREQROL]

FR-A8□0-E, FR-A8□2-E, FR-A8□6-E

FR-A8□0-GN, FR-A8□2-GN

FR-A8□0-E-CRN, FR-A8□2-E-CRN

FR-A8□0-E-R2R, FR-A8□2-E-R2R

FR-A8□0-E-AWH

FR-A8□0-E-LC

FR-F8□0-E, FR-F8□2-E

FR-E8□0-E

Controller or communication module [Unit Type] on GT Designer3
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*1 The following lists the applicable controllers.

Type Model

RCPU

RnCPU

R00CPU
R01CPU
R02CPU
R04CPU
R08CPU
R16CPU
R32CPU
R120CPU

Process CPU

R08PCPU
R16PCPU
R32PCPU
R120PCPU

SIL2 Process CPU

R08PSFCPU
R16PSFCPU
R32PSFCPU
R120PSFCPU

Safety CPU

R08SFCPU
R16SFCPU
R32SFCPU
R120SFCPU

RnENCPU

R04ENCPU
R08ENCPU
R16ENCPU
R32ENCPU
R120ENCPU

C Controller module R12CCPU-V

MELSECWinCPU R102WCPU-W
12 - 734 12. APPENDICES
12.5 [Unit Type] in [Connected Ethernet Controller Setting]



A
PP

EN
D

IC
ES

12
QCPU

Basic model QCPU
Q00JCPU
Q00CPU
Q01CPU

High Performance model 
QCPU

Q02CPU
Q02HCPU
Q06HCPU
Q12HCPU
Q25HCPU

Process CPU

Q02PHCPU
Q06PHCPU
Q12PHCPU
Q25PHCPU

Redundant CPU
Q12PRHCPU
Q25PRHCPU

Universal model QCPU

Q00UJCPU, Q00UJCPU-S8
Q00UCPU
Q01UCPU
Q02UCPU
Q03UDCPU
Q04UDHCPU
Q06UDHCPU
Q10UDHCPU
Q13UDHCPU
Q20UDHCPU
Q26UDHCPU
Q03UDECPU
Q04UDEHCPU
Q06UDEHCPU
Q10UDEHCPU
Q13UDEHCPU
Q20UDEHCPU
Q26UDEHCPU
Q50UDEHCPU
Q100UDEHCPU
Q03UDVCPU
Q04UDVCPU
Q06UDVCPU
Q13UDVCPU
Q26UDVCPU
Q04UDPVCPU
Q06UDPVCPU
Q13UDPVCPU
Q26UDPVCPU

C Controller module

Q12DCCPU-V
Q24DHCCPU-V
Q24DHCCPU-LS
Q24DHCCPU-VG
Q26DHCCPU-LS

Type Model
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■2 When connecting a non-Mitsubishi Electric equipment
Manufacturer Controller or communication module [Unit Type] on GT Designer3

OMRON PLC

SYSMAC CJ1
SYSMAC CJ2
SYSMAC CS1

[OMRON]

NJ
Built-in Ethernet port [OMRON NJ/NX]

Ethernet module [CJ1W-EIP21]

NX [OMRON NJ/NX]

KEYENCE PLC [KEYENCE]

TOSHIBA PLC [TOSHIBA]

HITACHI IES PLC [HITACHI IES]

HITACHI PLC [HITACHI]

FUJI PLC [FUJI]

YASKAWA PLC [YASKAWA]

YASKAWA robot controller [YASKAWA(YRC1000)]

YOKOGAWA PLC [YOKOGAWA]

 ALLEN-BRADLEY PLC

MicroLogix1000
MicroLogix1100
MicroLogix1200
MicroLogix1400
MicroLogix1500

[AB(MicroLogix)]

ControlLogix
CompactLogix

Set [Controller Type], and [Unit Type] is determined.
• [AB Control/CompactLogix]: [AB]
• [AB Control/CompactLogix(Tag)]: [AB(Tag)]

FlexLogix [AB(Tag)]

LS Industrial Systems PLC
Built-in Ethernet port [XGK-CPU]

Ethernet module [XGL-EFMT(B)]

SIEMENS PLC

SIMATIC S7-200 [S7-200 OP]

SIMATIC S7-200 SMART [S7-200 SMART OP]

SIMATIC S7-300
SIMATIC S7-400

Set [Controller Type], and [Unit Type] is selective.
• [SIEMENS S7(Ethernet)]: [SIEMENS S7]
• [SIEMENS OP(Ethernet)]: [S7-300/400 OP]

SIMATIC S7-1200 [S7-1200 OP]

SIMATIC S7-1500 [S7-1500 OP]

SLMP-compatible equipment [SLMP]

MODBUS equipment

To connect a controller under the following conditions, 
select [MODBUS/TCP].
• The unit ID is fixed to 255 (for connecting with the GOT 

as the host station).
• The unit ID is not fixed.
To connect a controller of another station, whose unit ID 
is fixed to 255, with the GOT, select [MODBUS/TCP(unit 
ID fixed)].
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12.6 ASCII Code List

The following shows of the list of ASCII Codes. (The blanks represent control code.)
0xA1 to 0xDF can be displayed only when the GOT's system language is Japanese.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.7 Restrictions for Folder Names and File Names used in GOT

■1 Characters which can be used in folder names and file names
• One-byte alphanumeric characters
• Symbols other than the followings
"*/:<>?\|
(A one-byte space cannot be used.)

■2 Character strings which cannot be used in folder names and file names
Folder names and file names containing only the following character strings (case-insensitive) cannot be used.
However, the character strings are usable as part of folder names and file names.
• COM1 to COM9
• LPT1 to LPT9
• AUX
• CON
• NUL
• PRN
• CLOCK$
The use of the following folder and file names is prohibited.
• Folder names starting with G2 (Except for file operation functions of script function used as arguments)
• Folder and file names starting with . (period) or \
• Folder and file names ending with . (period) or \
• Folder and file named as only . (one period) or .. (two periods)

■3 Number of characters for folder names and file names
GOTs recognize the location of a file with the following path.
Set a folder name and file name so that the total number of characters used for the path is 78 or less.
Only the folder name and file name in the path can be set by the user.
(Other part of the path is automatically specified.)
Example) File path stored by GT27 in the data storage (for CSV files)

When setting the folder name, enter \ between folder names.
(\ is counted as one character.)
Up to 20 hierarchy levels can be created.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Drive name (one character)

A maximum of 78 characters

Extension (four characters)(one character)(two characters)

Folder name File name\:\A .CSV
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12.8 Precautions for Using CSV File

This section describes precautions for using an imported/exported CSV file in GT Designer3.

■1 How to save CSV files
To edit a CSV file in Microsoft Excel and use the file in GT Designer3, save the file in the CSV (comma delimited) file 
format (*.csv). 
The file cannot be used if saved in the CSV UTF-8 (comma delimited) file format (*.csv).

■2 Editing the exported file
If a device in use has a name starting from 0, the 0 may be deleted by a function of applications for editing files 
(spreadsheet software and others).
If a file is saved with the leading zero removed from a device name, the file cannot be imported normally.
When using a device that has a name starting from 0, edit the file with a text editor.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.9 Precautions for Using Unicode Text File

This section explains for using a Unicode text file imported/exported by GT Designer3.

■1 How to save Unicode text files
To edit and use a Unicode text file exported by GT Designer3, save the file in the Unicode text file format (*.txt).
The character code applicable to Unicode text files is Unicode (file format: UTF16 LittleEndian).

■2 Displaying Unicode text files
To display Unicode text files on a personal computer and others, use software compatible to the Unicode.
Software that is not compatible with the Unicode cannot display Unicode text files properly.

■3 Displaying Unicode text files by Microsoft Excel
To open a Unicode text file that contains a comment of multiple lines by Microsoft Excel, drag the Unicode text file to the 
Microsoft Excel.
Methods other than above cannot display Unicode text files by Microsoft Excel properly.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.10 Data Transferred to the GOT and Storage Destination

Transfer the created project to the GOT with system application in units of the package data.
The GOT operates after expanding the data stored in the memory for storage to the memory for operation (RAM).
Some data is stored in the memory for storage with being compressed. When the data is expanded to the memory for 
operation (RAM), the data capacity increases.
The capacity of the package data to be transferred must be less than or equal to the available space of the memory for 
storage (ROM) and the memory for operation (RAM) at the destination.

The following shows the data transferred to the GOT and destination drive.

*1 Not available to GT23, GT21, and GS21.

Data type Storage destination (ROM) Expansion destination (RAM)

BootOS

Stored in the built-in flash memory (system 
area).
The data capacity to be stored in the system 
area is unnecessary to be considered.

Stored in the memory for operation (RAM) 
(system area).
The data capacity to be stored in the system 
area is unnecessary to be considered.

Package data

Project Data Stored in either of the following.
• Drive A
• Drive B
• Drive C
• Drive E
• Drive F
• Drive G
For the available drives by GOT model, refer to 
the following.

➟1.2.8 Drive configuration of the target GOT 
for data transfer

Memory for operation (RAM) (user area)

➟■2 Capacity of each drive of the GOT
Some data points are expanded to the memory 
for operation (RAM) (system area).

➟12.10.1 ■1 (2) Capacity of the package data 
expanded to the memory for operation (RAM)

System Application

Special Data*1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT Designer3

(Built-in flash memory)
Drive C

or

(Data storage)
Drive A, B, E, F, G

(RAM)
Memory for operation

ExpandTransfer

GOT

Memory for storage (ROM)

Example) For GT27
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12.10.1 Data transferred to the GOT and capacity of the destination drive

■1 Capacity of package data 
For how to check the capacity of the package data, refer to the following.

➟12.10.1 ■3 (1) Checking the capacity of the package data

(1) Capacity of the package data transferred to the memory for storage (ROM)
The total capacity of the project data, system application, and the special data must be less than or equal to the available 
space of the memory for storage (ROM).

For the available drives by GOT model, refer to the following.
➟1.2.8 Drive configuration of the target GOT for data transfer

(2) Capacity of the package data expanded to the memory for operation (RAM)
The total capacity of the project data, system application, and the special data must be less than or equal to the available 
space of the memory for operation (RAM).

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Project Data

Special Data

Package data

System Application
+

+

<

Package data

Project Data

System Application
+ <

GT27, GT25, GT23, GS25

GT21 and GS21

(Built-in flash memory)
Drive C

or

(Data storage)
Drive A, B, E, F, G

Memory for storage
(ROM)

*1 Not available to GT23.

*1 Drive E is not available for GS21.

*1

Memory for storage
(ROM)

(Built-in flash memory)
Drive C

or

(Data storage)
Drive A, E

<

Memory for operation
(RAM)

User area

<

GT27, GT25, GS25

GT23, GT21, and GS21

Project Data

Special Data

Package data

System Application
+

+

Package data

Project Data

System Application
+

Memory for operation
(RAM)

User area
12 - 742 12. APPENDICES
12.10 Data Transferred to the GOT and Storage Destination



A
PP

EN
D

IC
ES

12
The following data points of the system application are expanded to the system area of the memory for operation (RAM). 
Considering the data capacity is unnecessary.

■2 Capacity of each drive of the GOT
(1) GT27

Data type Data stored in the memory for operation (RAM) (system area)

System Application

Standard Function
Standard System Application

Standard Font

Extended Function
GOT Platform Library

GOT Function Expansion Library

Drive Name Capacity

Storage 
memory (ROM)

Drive A Standard SD card Depends on the data storage used.

Drive B USB Drive Depends on the data storage used.

Drive C Built-in flash memory (user area)
GT27 (except GT2705-V): 57 MB
GT2705-V: 32 MB

Drive E USB Drive

Depends on the data storage used.
The following models do not have drive E.
• GT2712-STWA
• GT2712-STWD
• GT2710-VTWA
• GT2710-VTWD

Drive F USB Drive Depends on the data storage used.

Drive G USB Drive Depends on the data storage used.

Drive X Current drive Depends on the data storage used.

Operation 
memory (RAM) - Memory for operation (RAM) (user area)

GT27 (except GT2705-V)
• Function version A and B: 128 MB
• Function version C or later: 256 MB
If the system application version is 01.38.*** or earlier, the 
capacity is 128 MB even though the function version is C or 
later.
GT2705-V: 80 MB
12. APPENDICES
12.10 Data Transferred to the GOT and Storage Destination

12 - 743



(2) GT25, GS25

(3) GT23

(4) GT21 and GS21

Drive Name Capacity

Storage 
memory (ROM)

Drive A Standard SD card Depends on the data storage used.

Drive B USB Drive

Depends on the data storage used.
The following models do not have drive B.
• GT2505-V
• GT25HS-V

Drive C Built-in flash memory (user area) 32 MB

Drive E USB Drive

Depends on the data storage used.
The following models do not have drive E.
• GT2512F-STNA
• GT2512F-STND
• GT2510-VTWA
• GT2510-VTWD
• GT2510F-VTNA
• GT2510F-VTND
• GT2508-VTWA
• GT2508-VTWD
• GT2508F-VTNA
• GT2508F-VTND
• GT2507T-WTSD

Drive F USB Drive Depends on the data storage used.

Drive G USB Drive Depends on the data storage used.

Drive X Current drive Depends on the data storage used.

Operation 
memory (RAM) - Memory for operation (RAM) (user area)

GT25-W, GS25: 128 MB
GT25-S, GT25-V, GT25HS-V: 80 MB

Drive Name Capacity

Storage 
memory (ROM)

Drive A Standard SD card Depends on the data storage used.

Drive B USB Drive Depends on the data storage used.

Drive C Built-in flash memory (user area) 9 MB

Drive E USB Drive Depends on the data storage used.

Drive F USB Drive Depends on the data storage used.

Drive G USB Drive Depends on the data storage used.

Drive X Current drive Depends on the data storage used.

Operation 
memory (RAM) - Memory for operation (RAM) (user area) 9 MB

Drive Name Capacity

Storage 
memory (ROM)

Drive A*1 Standard SD card Depends on the data storage used.

Drive C Built-in flash memory (user area)

• GT2107-W:15 MB
• GT2105-Q:9 MB
• GT2104-R:9 MB
• GT2104-P:6 MB
• GT2103-P:3 MB
• GS21-W-N: 15 MB
• GS21-W: 9 MB

Drive E USB Drive

Depends on the data storage used.
The following models do not have drive E.
• GT2105-Q
• GT2104-R
• GT2104-P
• GT2103-P
• GS21

Drive X Current drive Depends on the data storage used.
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*1 To use an SD card on GT2103-P, mount the SD card unit (GT21-03SDCD) on the GOT.

■3 Checking the capacity of the package data and available space of the destination drive
(1) Checking the capacity of the package data

• Checking in the [Data Size (Project)] dialog
➟11.11.2 Checking data size of project

• Checking in the [Write Option] dialog
➟4.8.3 [Write Option] dialog (for writing data to one GOT)

(2) Checking the available space of the destination drive
Checking [Communicate with GOT] dialog ([GOT Write] tab) or the [GOT Information - Detail] dialog

➟4.8.2 [Communicate with GOT] dialog

■4 Reducing the capacity of the package data
Reduce the capacity of the package data by the following methods when the capacity of the package data exceeds the 
capacity of the memory for storage (ROM) and the memory for operation (RAM).

(1) Using a set overlay screen
When you placing the same object on multiple screens, reduce the capacity of the data by using the set overlay screen.

➟8.29 Placing Another Screen on a Screen

(2) Reducing the number of figures and objects
Reduce the number of figures and objects placed on the screen.

(3) Reducing the number of the project settings
Delete unnecessary settings.

(4) Reducing the number of system applications transferred to the GOT
In the [Application Selection] dialog, deselect unnecessary system applications (extended functions) and special data.

➟4.2 Setting a System Application to be Written to the GOT
For the size of the system applications (extended functions) and the special data, refer to the following.

➟12.10.2 Transferred data size list

Operation 
memory (RAM) -

Memory for operation (RAM) (user area)

• GT2107-W:15 MB
• GT2105-Q:9 MB
• GT2104-R:9 MB
• GT2104-P:6 MB
• GT2103-P:3 MB
• GS21-W-N: 15 MB
• GS21-W: 9 MB

Memory for operation (RAM) (buffering area) 1 MB

Drive Name Capacity

BASE1 BASE2 BASE3

The capacity of the data increases
for the placed objects.

BASE1 BASE2 BASE3

Calling the screen to which the object is placed to each screen
The capacity of the data increases only for the object placed

on the called screen.

When objects are placed for each screen When a set overlay screen is used
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12.10.2 Transferred data size list

The following shows the data size of the system applications and special data used in the GOT.
➟■1 Data size of system applications
■2 Data size of special data

■1 Data size of system applications

➟(1) Communication driver (GT27)
(2) Communication driver (GT25)
(3) Communication driver (GT23)
(4) Communication driver (GT21)
(5) Communication driver (GS25)
(6) Communication driver (GS21)
(7) Extended function (GT27)
(8) Extended function (GT25)
(9) Extended function (GT23)
(10) Extended function (GT21)
(11) Extended function (GS25)
(12) Extended function (GS21)

(1) Communication driver (GT27)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Bus/Network Group]

[BuS(A/QnA)] 800 KB 795 KB

[BUS(Q)] 840 KB 945 KB

[MELSECNET/H] 840 KB 945 KB

[CC-Link IE TSN] 535 KB 785 KB

[CC-Link IE Controller Network] 840 KB 945 KB

[CC-Link IE Field Network] 840 KB 945 KB

[CC-Link Ver.2(ID)] 820 KB 945 KB
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[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 840 KB 975 KB

[Ethernet(FX), Gateway] 600 KB 735 KB

[Ethernet(MELSERVO), Gateway] 680 KB 875 KB

[Ethernet(FREQROL), Gateway] 240 KB 405 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 310 KB 588 KB

[Ethernet(OMRON), Gateway] 320 KB 525 KB

[Ethernet(OMRON NJ/NX), Gateway] 229.4 KB 532.5 KB

[Ethernet(KEYENCE), Gateway] 260 KB 465 KB

[Ethernet(MICROCOMPUTER)] 200 KB 335 KB

[Ethernet(TOSHIBA nv), Gateway] 195 KB 330 KB

[Ethernet(HITACHI IES), Gateway] 300 KB 365 KB

[Ethernet(HITACHI), Gateway] 235 KB 410 KB

[Ethernet(FUJI), Gateway] 270 KB 490 KB

[Ethernet(YASKAWA), Gateway] 340 KB 585 KB

[Ethernet(YASKAWA MP3000), Gateway] 315 KB 654 KB

[Ethernet(YASKAWA High Speed Ethernet Server), Gateway] 170 KB 350 KB

[Ethernet(YOKOGAWA), Gateway] 420 KB 625 KB

[Ethernet(AB MicroLogix), Gateway] 415 KB 470 KB

[Ethernet(AB), Gateway] 340 KB 495 KB

[Ethernet(AB Tag), Gateway] 300 KB 1055 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 250 KB 315 KB

[Ethernet(SIEMENS S7), Gateway] 300 KB 445 KB

[Ethernet(SIEMENS OP), Gateway] 360 KB 445 KB

[Ethernet(CC-Link IE Field Network Basic)] 180 KB 718 KB

[Ethernet(SLMP), Gateway] 220 KB 720 KB

[MODBUS/TCP Master, Gateway] 280 KB 405 KB

[MODBUS/TCP Slave, Gateway] 197 KB 1654 KB

[Serial(MELSEC)] 840 KB 975 KB

[AJ71QC24, MELDAS C6*] 800 KB 905 KB

[AJ71C24/UC24] 800 KB 795 KB

[MELSEC-FX] 600 KB 735 KB

[MELSEC-WS] 240 KB 295 KB

[CC-Link(G4)] 800 KB 905 KB

[MELSERVO-J4,J3,J2S/M,JE] 680 KB 875 KB

[Multidrop(Slave)] 800 KB 905 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 240 KB 405 KB

[FREQROL 800] 240 KB 405 KB

[FREQROL(Batch monitor)] 300 KB 610 KB

[IAI X-SEL] 240 KB 445 KB

[IAI ROBO CYLINDER] 240 KB 445 KB

[Azbil SDC/DMC] 200 KB 375 KB

[Azbil DMC50] 200 KB 375 KB

[OMRON SYSMAC] 200 KB 505 KB

[OMRON THERMAC/INPANEL NEO] 200 KB 295 KB

[OMRON Digital Temperature Controller] 192 KB 396 KB

[Serial(KEYENCE)] 260 KB 455 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[KOYO KOSTAC/DL] 200 KB 295 KB

[JTECT TOYOPUC-PC] 220 KB 425 KB

[SHARP JW] 220 KB 325 KB

[SHINKO TECHNOS CONTROLLER] 200 KB 375 KB

[CHINO MODBUS device] 200 KB 375 KB

[TOSHIBA PROSEC T/V] 200 KB 395 KB

[SHIBAURA MACHINE TCmini] 220 KB 335 KB

[Panasonic MEWNET-FP] 200 KB 395 KB

[Panasonic MEWTOCOL-7] 285 KB 590 KB

[Panasonic MINAS A4] 320 KB 565 KB

[Panasonic MINAS A5] 320 KB 565 KB

[HITACHI IES HIDIC H] 220 KB 415 KB

[HITACHI IES HIDIC H(Protocol2)] 220 KB 415 KB

[HITACHI S10mini/S10V] 240 KB 445 KB

[Hirata HNC] 240 KB 440 KB

[FUJI Temperature Controller/Digital Controller] 200 KB 375 KB

[FUJI MICREX-F] 340 KB 535 KB

[FUJI MICREX-SX SPH] 280 KB 435 KB

[Muratec MPC] 150 KB 290 KB

[Muratec MCR] 150 KB 315 KB

[YASKAWA GL] 260 KB 465 KB

[YASKAWA CP9200(H)] 260 KB 465 KB

[YASKAWA CP9300MS(MC compatible)] 260 KB 465 KB

[YASKAWA MP2000/MP900/CP9200SH] 260 KB 465 KB

[YOKOGAWA FA500/FA-M3/STARDOM] 460 KB 625 KB

[YOKOGAWA GREEN/UT100/UT2000/UT Advance] 360 KB 595 KB

[RKC SR Mini HG(MODBUS)] 260 KB 495 KB

[AB SLC500,AB 1:N] 400 KB 575 KB

[AB MicroLogix] 400 KB 575 KB

[AB MicroLogix(Extended)] 400 KB 575 KB

[AB Control/CompactLogix] 360 KB 525 KB

[GE (SNP-X)] 200 KB 295 KB

[LS Industrial Systems MASTER-K] 200 KB 385 KB

[MEI Nexgenie] 305 KB 535 KB

[SICK Flexi Soft] 260 KB 295 KB

[SIEMENS S7-300/400] 300 KB 405 KB

[SIEMENS S7-200] 320 KB 405 KB

[MODBUS/RTU Master] 260 KB 495 KB

[MODBUS/RTU Slave] 222 KB 1676 KB

[DeviceNet] 255 KB 380 KB

[PROFIBUS DP] 255 KB 385 KB

[Computer] 200 KB 375 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(2) Communication driver (GT25)

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Bus/Network Group]

[BuS(A/QnA)] 800 KB 795 KB

[BUS(Q)] 840 KB 945 KB

[MELSECNET/H] 840 KB 945 KB

[CC-Link IE TSN] 535 KB 785 KB

[CC-Link IE Controller Network] 840 KB 945 KB

[CC-Link IE Field Network] 840 KB 945 KB

[CC-Link Ver.2(ID)] 820 KB 945 KB

[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 840 KB 975 KB

[Ethernet(FX), Gateway] 600 KB 735 KB

[Ethernet(MELSERVO), Gateway] 680 KB 875 KB

[Ethernet(FREQROL), Gateway] 240 KB 405 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 310 KB 588 KB

[Ethernet(OMRON), Gateway] 320 KB 525 KB

[Ethernet(OMRON NJ/NX), Gateway] 229.4 KB 532.5 KB

[Ethernet(KEYENCE), Gateway] 260 KB 465 KB

[Ethernet(MICROCOMPUTER)] 200 KB 335 KB

[Ethernet(TOSHIBA nv), Gateway] 195 KB 330 KB

[Ethernet(HITACHI IES), Gateway] 300 KB 365 KB

[Ethernet(HITACHI), Gateway] 235 KB 410 KB

[Ethernet(FUJI), Gateway] 270 KB 490 KB

[Ethernet(YASKAWA), Gateway] 340 KB 585 KB

[Ethernet(YASKAWA MP3000), Gateway] 315 KB 654 KB

[Ethernet(YASKAWA High Speed Ethernet Server), Gateway] 170 KB 350 KB

[Ethernet(YOKOGAWA), Gateway] 420 KB 625 KB

[Ethernet(AB MicroLogix), Gateway] 415 KB 470 KB

[Ethernet(AB), Gateway] 340 KB 495 KB

[Ethernet(AB Tag), Gateway] 300 KB 1055 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 250 KB 315 KB

[Ethernet(SIEMENS S7), Gateway] 300 KB 445 KB

[Ethernet(SIEMENS OP), Gateway] 360 KB 445 KB

[Ethernet(CC-Link IE Field Network Basic)] 180 KB 718 KB

[Ethernet(SLMP), Gateway] 220 KB 720 KB

[MODBUS/TCP Master, Gateway] 280 KB 405 KB

[MODBUS/TCP Slave, Gateway] 197 KB 1654 KB

[Serial(MELSEC)] 840 KB 975 KB

[AJ71QC24, MELDAS C6*] 800 KB 905 KB

[AJ71C24/UC24] 800 KB 795 KB

[MELSEC-FX] 600 KB 735 KB

[MELSEC-WS] 240 KB 295 KB

[CC-Link(G4)] 800 KB 905 KB

[MELSERVO-J4,J3,J2S/M,JE] 680 KB 875 KB

[Multidrop(Slave)] 800 KB 905 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 240 KB 405 KB

[FREQROL 800] 240 KB 405 KB

[FREQROL(Batch monitor)] 300 KB 610 KB
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[IAI X-SEL] 240 KB 445 KB

[IAI ROBO CYLINDER] 240 KB 445 KB

[Azbil SDC/DMC] 200 KB 375 KB

[Azbil DMC50] 200 KB 375 KB

[OMRON SYSMAC] 200 KB 505 KB

[OMRON THERMAC/INPANEL NEO] 200 KB 295 KB

[OMRON Digital Temperature Controller] 192 KB 396 KB

[Serial(KEYENCE)] 260 KB 455 KB

[KOYO KOSTAC/DL] 200 KB 295 KB

[JTECT TOYOPUC-PC] 220 KB 425 KB

[SHARP JW] 220 KB 325 KB

[SHINKO TECHNOS CONTROLLER] 200 KB 375 KB

[CHINO MODBUS device] 200 KB 375 KB

[TOSHIBA PROSEC T/V] 200 KB 395 KB

[SHIBAURA MACHINE TCmini] 220 KB 335 KB

[Panasonic MEWNET-FP] 200 KB 395 KB

[Panasonic MEWTOCOL-7] 285 KB 590 KB

[Panasonic MINAS A4] 320 KB 565 KB

[Panasonic MINAS A5] 320 KB 565 KB

[HITACHI IES HIDIC H] 220 KB 415 KB

[HITACHI IES HIDIC H(Protocol2)] 220 KB 415 KB

[HITACHI S10mini/S10V] 240 KB 445 KB

[Hirata HNC] 240 KB 440 KB

[FUJI Temperature Controller/Digital Controller] 200 KB 375 KB

[FUJI MICREX-F] 340 KB 535 KB

[FUJI MICREX-SX SPH] 280 KB 435 KB

[Muratec MPC] 150 KB 290 KB

[Muratec MCR] 150 KB 315 KB

[YASKAWA GL] 260 KB 465 KB

[YASKAWA CP9200(H)] 260 KB 465 KB

[YASKAWA CP9300MS(MC compatible)] 260 KB 465 KB

[YASKAWA MP2000/MP900/CP9200SH] 260 KB 465 KB

[YOKOGAWA FA500/FA-M3/STARDOM] 460 KB 625 KB

[YOKOGAWA GREEN/UT100/UT2000/UT Advance] 360 KB 595 KB

[RKC SR Mini HG(MODBUS)] 260 KB 495 KB

[AB SLC500,AB 1:N] 400 KB 575 KB

[AB MicroLogix] 400 KB 575 KB

[AB MicroLogix(Extended)] 400 KB 575 KB

[AB Control/CompactLogix] 360 KB 525 KB

[GE (SNP-X)] 200 KB 295 KB

[LS Industrial Systems MASTER-K] 200 KB 385 KB

[MEI Nexgenie] 305 KB 535 KB

[SICK Flexi Soft] 260 KB 295 KB

[SIEMENS S7-300/400] 300 KB 405 KB

[SIEMENS S7-200] 320 KB 405 KB

[MODBUS/RTU Master] 260 KB 495 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(3) Communication driver (GT23)

[MODBUS/RTU Slave] 222 KB 1676 KB

[DeviceNet] 255 KB 380 KB

[PROFIBUS DP] 255 KB 385 KB

[Computer] 200 KB 375 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 840 KB 975 KB

[Ethernet(FX), Gateway] 600 KB 735 KB

[Ethernet(MELSERVO), Gateway] 680 KB 875 KB

[Ethernet(FREQROL), Gateway] 240 KB 405 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 310 KB 588 KB

[Ethernet(OMRON), Gateway] 320 KB 525 KB

[Ethernet(OMRON NJ/NX), Gateway] 229.4 KB 532.5 KB

[Ethernet(KEYENCE), Gateway] 260 KB 465 KB

[Ethernet(MICROCOMPUTER)] 200 KB 335 KB

[Ethernet(TOSHIBA nv), Gateway] 195 KB 330 KB

[Ethernet(HITACHI IES), Gateway] 300 KB 365 KB

[Ethernet(HITACHI), Gateway] 235 KB 410 KB

[Ethernet(FUJI), Gateway] 270 KB 490 KB

[Ethernet(YASKAWA), Gateway] 340 KB 585 KB

[Ethernet(YASKAWA MP3000), Gateway] 315 KB 654 KB

[Ethernet(YASKAWA High Speed Ethernet Server), Gateway] 170 KB 350 KB

[Ethernet(YOKOGAWA), Gateway] 420 KB 625 KB

[Ethernet(AB MicroLogix), Gateway] 415 KB 470 KB

[Ethernet(AB), Gateway] 340 KB 495 KB

[Ethernet(AB Tag), Gateway] 300 KB 1055 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 250 KB 315 KB

[Ethernet(SIEMENS S7), Gateway] 300 KB 445 KB

[Ethernet(SIEMENS OP), Gateway] 360 KB 445 KB

[Ethernet(CC-Link IE Field Network Basic)] 185 KB 718 KB

[Ethernet(SLMP), Gateway] 220 KB 720 KB

[MODBUS/TCP Master, Gateway] 280 KB 405 KB

[MODBUS/TCP Slave, Gateway] 197 KB 1654 KB

[Serial(MELSEC)] 840 KB 975 KB

[AJ71QC24, MELDAS C6*] 800 KB 905 KB

[AJ71C24/UC24] 800 KB 795 KB

[MELSEC-FX] 600 KB 735 KB

[MELSEC-WS] 240 KB 295 KB

[CC-Link(G4)] 800 KB 905 KB

[MELSERVO-J4,J3,J2S/M,JE] 680 KB 875 KB

[Multidrop(Slave)] 800 KB 905 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 240 KB 405 KB

[FREQROL 800] 240 KB 405 KB

[FREQROL(Batch monitor)] 300 KB 610 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[IAI X-SEL] 240 KB 445 KB

[IAI ROBO CYLINDER] 240 KB 445 KB

[Azbil SDC/DMC] 200 KB 375 KB

[Azbil DMC50] 200 KB 375 KB

[OMRON SYSMAC] 200 KB 505 KB

[OMRON THERMAC/INPANEL NEO] 200 KB 295 KB

[OMRON Digital Temperature Controller] 192 KB 396 KB

[Serial(KEYENCE)] 260 KB 455 KB

[KOYO KOSTAC/DL] 200 KB 295 KB

[JTECT TOYOPUC-PC] 220 KB 425 KB

[SHARP JW] 220 KB 325 KB

[SHINKO TECHNOS CONTROLLER] 200 KB 375 KB

[CHINO MODBUS device] 200 KB 375 KB

[TOSHIBA PROSEC T/V] 200 KB 395 KB

[SHIBAURA MACHINE TCmini] 220 KB 335 KB

[Panasonic MEWNET-FP] 200 KB 395 KB

[Panasonic MEWTOCOL-7] 285 KB 590 KB

[Panasonic MINAS A4] 320 KB 565 KB

[Panasonic MINAS A5] 320 KB 565 KB

[HITACHI IES HIDIC H] 220 KB 415 KB

[HITACHI IES HIDIC H(Protocol2)] 220 KB 415 KB

[HITACHI S10mini/S10V] 240 KB 445 KB

[Hirata HNC] 240 KB 440 KB

[FUJI Temperature Controller/Digital Controller] 200 KB 375 KB

[FUJI MICREX-F] 340 KB 535 KB

[FUJI MICREX-SX SPH] 280 KB 435 KB

[Muratec MPC] 150 KB 290 KB

[Muratec MCR] 150 KB 315 KB

[YASKAWA GL] 260 KB 465 KB

[YASKAWA CP9200(H)] 260 KB 465 KB

[YASKAWA CP9300MS(MC compatible)] 260 KB 465 KB

[YASKAWA MP2000/MP900/CP9200SH] 260 KB 465 KB

[YOKOGAWA FA500/FA-M3/STARDOM] 460 KB 625 KB

[YOKOGAWA GREEN/UT100/UT2000/UT Advance] 360 KB 595 KB

[RKC SR Mini HG(MODBUS)] 260 KB 495 KB

[AB SLC500,AB 1:N] 400 KB 575 KB

[AB MicroLogix] 400 KB 575 KB

[AB MicroLogix(Extended)] 400 KB 575 KB

[AB Control/CompactLogix] 360 KB 525 KB

[GE (SNP-X)] 200 KB 295 KB

[LS Industrial Systems MASTER-K] 200 KB 385 KB

[MEI Nexgenie] 305 KB 535 KB

[SICK Flexi Soft] 260 KB 295 KB

[SIEMENS S7-300/400] 300 KB 405 KB

[SIEMENS S7-200] 320 KB 405 KB

[MODBUS/RTU Master] 260 KB 495 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(4) Communication driver (GT21)

[MODBUS/RTU Slave] 222 KB 1676 KB

[Computer] 200 KB 375 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 0 KB 0 KB

[Ethernet(FX), Gateway] 0 KB 0 KB

[Ethernet(MELSERVO), Gateway] 0 KB 0 KB

[Ethernet(FREQROL), Gateway] 0 KB 0 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 0 KB 0 KB

[Ethernet(OMRON), Gateway] 0 KB 0 KB

[Ethernet(OMRON NJ/NX), Gateway] 0 KB 0 KB

[Ethernet(KEYENCE), Gateway] 0 KB 0 KB

[Ethernet(FUJI), Gateway] 0 KB 0 KB

[Ethernet(YASKAWA), Gateway] 0 KB 0 KB

[Ethernet(YASKAWA MP3000), Gateway] 0 KB 0 KB

[Ethernet(AB), Gateway] 0 KB 0 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 0 KB 0 KB

[Ethernet(SIEMENS OP), Gateway] 0 KB 0 KB

[Ethernet(CC-Link IE Field Network Basic)] 0 KB 0 KB

[Ethernet(SLMP), Gateway] 0 KB 0 KB

[MODBUS/TCP Master, Gateway] 0 KB 0 KB

[MODBUS/TCP Slave, Gateway] 0 KB 0 KB

[Ethernet(MICROCOMPUTER)] 0 KB 0 KB

[Serial(MELSEC)] 0 KB 0 KB

[MELSEC-A] 0 KB 0 KB

[AJ71C24/UC24] 0 KB 0 KB

[MELSEC-FX] 0 KB 0 KB

[MELSEC-WS] 0 KB 0 KB

[CC-Link(G4)] 0 KB 0 KB

[MELSERVO-J4,J3,J2S/M,JE] 0 KB 0 KB

[Multidrop(Slave)] 0 KB 0 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 0 KB 0 KB

[FREQROL 800] 0 KB 0 KB

[FREQROL(Batch monitor)] 0 KB 0 KB

[Laser Displacement Sensor MH11]
(Only available to GT2104-PMBDS2)

0 KB 0 KB

[IAI X-SEL] 0 KB 0 KB

[IAI ROBO CYLINDER] 0 KB 0 KB

[Azbil SDC/DMC] 0 KB 0 KB

[Azbil DMC50] 0 KB 0 KB

[OMRON SYSMAC] 0 KB 0 KB

[OMRON THERMAC/INPANEL NEO] 0 KB 0 KB

[OMRON Digital Temperature Controller] 0 KB 0 KB

[Serial(KEYENCE)] 0 KB 0 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(5) Communication driver (GS25)

[SHIBAURA MACHINE TCmini] 0 KB 0 KB

[Panasonic MEWNET-FP] 0 KB 0 KB

[Panasonic MEWTOCOL-7] 0 KB 0 KB

[FUJI Temperature Controller/Digital Controller] 0 KB 0 KB

[FUJI MICREX-SX SPH] 0 KB 0 KB

[YASKAWA MP2000/MP900/CP9200SH] 0 KB 0 KB

[AB SLC500, AB 1:N] 0 KB 0 KB

[AB MicroLogix] 0 KB 0 KB

[LS Industrial Systems MASTER-K] 0 KB 0 KB

[MEI Nexgenie] 0 KB 0 KB

[SICK Flexi Soft] 0 KB 0 KB

[SIEMENS S7-300/400] 0 KB 0 KB

[SIEMENS S7-200] 0 KB 0 KB

[MODBUS/RTU Master] 0 KB 0 KB

[MODBUS/RTU Slave] 0 KB 0 KB

[Computer] 0 KB 0 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Bus/Network Group]

[BuS(A/QnA)] 800 KB 795 KB

[BUS(Q)] 840 KB 945 KB

[MELSECNET/H] 840 KB 945 KB

[CC-Link IE Controller Network] 840 KB 945 KB

[CC-Link IE Field Network] 840 KB 945 KB

[CC-Link Ver.2(ID)] 820 KB 945 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 840 KB 975 KB

[Ethernet(FX), Gateway] 600 KB 735 KB

[Ethernet(MELSERVO), Gateway] 680 KB 875 KB

[Ethernet(FREQROL), Gateway] 240 KB 405 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 310 KB 588 KB

[Ethernet(OMRON), Gateway] 320 KB 525 KB

[Ethernet(OMRON NJ/NX), Gateway] 229.4 KB 532.5 KB

[Ethernet(KEYENCE), Gateway] 260 KB 465 KB

[Ethernet(MICROCOMPUTER)] 200 KB 335 KB

[Ethernet(TOSHIBA nv), Gateway] 195 KB 330 KB

[Ethernet(HITACHI IES), Gateway] 300 KB 365 KB

[Ethernet(HITACHI), Gateway] 235 KB 410 KB

[Ethernet(FUJI), Gateway] 270 KB 490 KB

[Ethernet(YASKAWA), Gateway] 340 KB 585 KB

[Ethernet(YASKAWA MP3000), Gateway] 315 KB 654 KB

[Ethernet(YASKAWA High Speed Ethernet Server), Gateway] 170 KB 350 KB

[Ethernet(YOKOGAWA), Gateway] 420 KB 625 KB

[Ethernet(AB MicroLogix), Gateway] 415 KB 470 KB

[Ethernet(AB), Gateway] 340 KB 495 KB

[Ethernet(AB Tag), Gateway] 300 KB 1055 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 250 KB 315 KB

[Ethernet(SIEMENS S7), Gateway] 300 KB 445 KB

[Ethernet(SIEMENS OP), Gateway] 360 KB 445 KB

[Ethernet(CC-Link IE Field Network Basic)] 180 KB 718 KB

[Ethernet(SLMP), Gateway] 220 KB 720 KB

[MODBUS/TCP Master, Gateway] 280 KB 405 KB

[MODBUS/TCP Slave, Gateway] 197 KB 1654 KB

[Serial(MELSEC)] 840 KB 975 KB

[AJ71QC24, MELDAS C6*] 800 KB 905 KB

[AJ71C24/UC24] 800 KB 795 KB

[MELSEC-FX] 600 KB 735 KB

[MELSEC-WS] 240 KB 295 KB

[CC-Link(G4)] 800 KB 905 KB

[MELSERVO-J4,J3,J2S/M,JE] 680 KB 875 KB

[Multidrop(Slave)] 800 KB 905 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 240 KB 405 KB

[FREQROL 800] 240 KB 405 KB

[FREQROL(Batch monitor)] 300 KB 610 KB

[IAI X-SEL] 240 KB 445 KB

[IAI ROBO CYLINDER] 240 KB 445 KB

[Azbil SDC/DMC] 200 KB 375 KB

[Azbil DMC50] 200 KB 375 KB

[OMRON SYSMAC] 200 KB 505 KB

[OMRON THERMAC/INPANEL NEO] 200 KB 295 KB

[OMRON Digital Temperature Controller] 192 KB 396 KB

[Serial(KEYENCE)] 260 KB 455 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[KOYO KOSTAC/DL] 200 KB 295 KB

[JTECT TOYOPUC-PC] 220 KB 425 KB

[SHARP JW] 220 KB 325 KB

[SHINKO TECHNOS CONTROLLER] 200 KB 375 KB

[CHINO MODBUS device] 200 KB 375 KB

[TOSHIBA PROSEC T/V] 200 KB 395 KB

[SHIBAURA MACHINE TCmini] 220 KB 335 KB

[Panasonic MEWNET-FP] 200 KB 395 KB

[Panasonic MEWTOCOL-7] 285 KB 590 KB

[Panasonic MINAS A4] 320 KB 565 KB

[Panasonic MINAS A5] 320 KB 565 KB

[HITACHI IES HIDIC H] 220 KB 415 KB

[HITACHI IES HIDIC H(Protocol2)] 220 KB 415 KB

[HITACHI S10mini/S10V] 240 KB 445 KB

[Hirata HNC] 240 KB 440 KB

[FUJI Temperature Controller/Digital Controller] 200 KB 375 KB

[FUJI MICREX-F] 340 KB 535 KB

[FUJI MICREX-SX SPH] 280 KB 435 KB

[Muratec MPC] 150 KB 290 KB

[Muratec MCR] 150 KB 315 KB

[YASKAWA GL] 260 KB 465 KB

[YASKAWA CP9200(H)] 260 KB 465 KB

[YASKAWA CP9300MS(MC compatible)] 260 KB 465 KB

[YASKAWA MP2000/MP900/CP9200SH] 260 KB 465 KB

[YOKOGAWA FA500/FA-M3/STARDOM] 460 KB 625 KB

[YOKOGAWA GREEN/UT100/UT2000/UT Advance] 360 KB 595 KB

[RKC SR Mini HG(MODBUS)] 260 KB 495 KB

[AB SLC500,AB 1:N] 400 KB 575 KB

[AB MicroLogix] 400 KB 575 KB

[AB MicroLogix(Extended)] 400 KB 575 KB

[AB Control/CompactLogix] 360 KB 525 KB

[GE (SNP-X)] 200 KB 295 KB

[LS Industrial Systems MASTER-K] 200 KB 385 KB

[MEI Nexgenie] 305 KB 535 KB

[SICK Flexi Soft] 260 KB 295 KB

[SIEMENS S7-300/400] 300 KB 405 KB

[SIEMENS S7-200] 320 KB 405 KB

[MODBUS/RTU Master] 260 KB 495 KB

[MODBUS/RTU Slave] 222 KB 1676 KB

[DeviceNet] 255 KB 380 KB

[PROFIBUS DP] 255 KB 385 KB

[Computer] 200 KB 375 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(6) Communication driver (GS21)

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Ethernet Connection]

[Ethernet(MITSUBISHI ELECTRIC), Gateway] 0 KB 0 KB

[Ethernet(FX), Gateway] 0 KB 0 KB

[Ethernet(MELSERVO), Gateway] 0 KB 0 KB

[Ethernet(FREQROL), Gateway] 0 KB 0 KB

[Ethernet(FREQROL(Batch monitor)), Gateway] 0 KB 0 KB

[Ethernet(OMRON), Gateway] 0 KB 0 KB

[Ethernet(OMRON NJ/NX), Gateway] 0 KB 0 KB

[Ethernet(KEYENCE), Gateway] 0 KB 0 KB

[Ethernet(FUJI), Gateway] 0 KB 0 KB

[Ethernet(YASKAWA), Gateway] 0 KB 0 KB

[Ethernet(YASKAWA MP3000), Gateway] 0 KB 0 KB

[Ethernet(AB), Gateway] 0 KB 0 KB

[Ethernet(LS Industrial Systems XGK), Gateway] 0 KB 0 KB

[Ethernet(SIEMENS OP), Gateway] 0 KB 0 KB

[Ethernet(CC-Link IE Field Network Basic)] 0 KB 0 KB

[Ethernet(SLMP), Gateway] 0 KB 0 KB

[MODBUS/TCP Master, Gateway] 0 KB 0 KB

[MODBUS/TCP Slave, Gateway] 0 KB 0 KB

[Ethernet(MICROCOMPUTER)] 0 KB 0 KB

[Serial(MELSEC)] 0 KB 0 KB

[MELSEC-A] 0 KB 0 KB

[AJ71C24/UC24] 0 KB 0 KB

[MELSEC-FX] 0 KB 0 KB

[MELSEC-WS] 0 KB 0 KB

[CC-Link(G4)] 0 KB 0 KB

[MELSERVO-J4,J3,J2S/M,JE] 0 KB 0 KB

[Multidrop(Slave)]
(Only available to GS21-W-N) 0 KB 0 KB

[FREQROL 500/700/800, SENSORLESS SERVO] 0 KB 0 KB

[FREQROL 800] 0 KB 0 KB

[FREQROL(Batch monitor)] 0 KB 0 KB

[IAI X-SEL] 0 KB 0 KB

[IAI ROBO CYLINDER] 0 KB 0 KB

[Azbil SDC/DMC] 0 KB 0 KB

[Azbil DMC50] 0 KB 0 KB

[OMRON SYSMAC] 0 KB 0 KB

[OMRON THERMAC/INPANEL NEO] 0 KB 0 KB

[OMRON Digital Temperature Controller] 0 KB 0 KB

[Serial(KEYENCE)] 0 KB 0 KB

[SHIBAURA MACHINE TCmini] 0 KB 0 KB

[Panasonic MEWNET-FP] 0 KB 0 KB

[Panasonic MEWTOCOL-7] 0 KB 0 KB

[FUJI Temperature Controller/Digital Controller] 0 KB 0 KB

[FUJI MICREX-SX SPH] 0 KB 0 KB

[YASKAWA MP2000/MP900/CP9200SH] 0 KB 0 KB
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(7) Extended function (GT27)

[AB SLC500, AB 1:N] 0 KB 0 KB

[AB MicroLogix] 0 KB 0 KB

[LS Industrial Systems MASTER-K] 0 KB 0 KB

[MEI Nexgenie] 0 KB 0 KB

[SICK Flexi Soft] 0 KB 0 KB

[SIEMENS S7-300/400] 0 KB 0 KB

[SIEMENS S7-200] 0 KB 0 KB

[MODBUS/RTU Master] 0 KB 0 KB

[MODBUS/RTU Slave] 0 KB 0 KB

[Computer] 0 KB 0 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Key Window Design Information]

When a basic-type or stylish-type screen design is used 1255 KB 2615 KB

When a dark-tone-flat-type or light-tone-flat-type screen design 
is used 567 KB 2103 KB

[Base Screen Size Expansion] 40 KB 60 KB

[Graphic Acceleration Driver] 2048 KB 15910 KB

[Standard Font]

[Japanese] 460 KB 1440 KB

[Chinese(Simplified)] 320 KB 960 KB

[Chinese(Traditional)] 500 KB 1300 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 450 KB 800 KB

[Japanese(Kanji)] 1150 KB 1980 KB

[Chinese(Simplified)]
(Character code: [GB2312])

600 KB 960 KB

[Chinese(Simplified)]
(Character code: [GBK])

1600 KB 2140 KB

[Chinese(Traditional)] 1100 KB 1800 KB

[Hangul] 300 KB 840 KB

[Kaisho]

[Alphanumeric/Kana] 510 KB 928 KB

[Japanese(Kanji)] 1200 KB 1853 KB

[Chinese(Simplified)]
(Character code: [GB2312])

570 KB 960KB

[Chinese(Simplified)]
(Character code: [GBK])

1780 KB 2340 KB

[Chinese(Traditional)] 1400 KB 2070 KB

[Hangul] 300 KB 870 KB

[Kana-Kanji/Pinyin Conversion]

When [Kana-Kanji] is selected in the [Environmental Setting] 
window ([Kana-Kanji/Pinyin Conversion]) 1001 KB 1800 KB

When [Pinyin Simplified Characters] is selected in the 
[Environmental Setting] window ([Kana-Kanji/Pinyin 
Conversion])

2128 KB 3245 KB

[Wireless LAN] 600 KB 512 KB

[SoftGOT-GOT Link Function] 40 KB 200 KB

[System Launcher]
[System Launcher (Basic)] 701 KB 2309 KB

[System Launcher (Servo Network)] 330 KB 1530 KB

[iQSS Utility] 631 KB 1613 KB

[Network Drive] 883 KB 2565 KB

Communication driver
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[Sequence Program Monitor]

[Sequence Program Monitor(Ladder)] 970 KB 2620 KB

[Sequence Program Monitor(iQ-R/iQ-L Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(iQ-F Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(SFC)] 740 KB 1420 KB

[FX Ladder Monitor] 760 KB 760 KB

[Backup/Restoration] 320 KB 860 KB

[Gateway]

[Gateway(Server, Client)] 200 KB 500 KB

[Gateway(Mail)] 128 KB 500 KB

[Gateway(FTP Server)] 60 KB 400 KB

[File Transfer] 40 KB 2100 KB

[Barcode]
[Bar Code (Serial)] 40 KB 100 KB

[Bar Code (USB)] 40 KB 100 KB

[RFID] 40 KB 100 KB

[PC Remote Operation(Serial)] 40 KB 60 KB

[PC Remote Operation(Ethernet)]
[Graphics Setting] is set to [GOT Graphic Ver.2] 345 KB 6640 KB

[Graphics Setting] is set to [GOT Graphic Ver.1] 200 KB 4440 KB

[VNC Server] 280 KB 5140 KB

[Video/Multimedia]

[Video/RGB] 120 KB 240 KB

[Video/RGB (Object)] 190 KB 567 KB

[Multimedia] 335 KB 660 KB

[External I/O / Operation Panel] 80 KB 100 KB

[Report] 50 KB 100 KB

[Printer]

[Printer(PictBridge)] 260 KB 1110 KB

[Printer(Serial)] 80 KB 200 KB

[Printer(ESC/P-R)] 100 KB 3072 KB

[Printer(PCL5)] 100 KB 3072 KB

[Sound Output] 100 KB 200 KB

[GOT Network Interaction] 100 KB 977 KB

[GOT Mobile Function] 4904 KB 13693 KB

[Device Data Transfer] 40 KB 100 KB

[Hard Copy PDF Output] 280 KB 20992 KB

[MES Interface] 512 KB 500 KB

[Device monitor] 400 KB 1180 KB

[Network monitor] 260 KB 340 KB

[Log Viewer] 1240 KB 3800 KB

[Intelligent module monitor] 460 KB 620 KB

[Servo amplifier monitor] 660 KB 680 KB

[Drive Recorder] 780 KB 2918 KB

[Servo amplifier graph] 860 KB 11410 KB

[R motion monitor] 1100 KB 1600 KB

[Q motion monitor] 720 KB 660 KB

[CNC Monitor] 600 KB 1500 KB

[CNC Data I/O] 310 KB 880 KB

[CNC Manufacturing Program Editor] 290 KB 738 KB

[CNC Monitor 2] 350 KB 2700 KB

[Motion Program Editor] 310 KB 760 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(8) Extended function (GT25)

[Motion Program Input/Output] 810 KB 1110 KB

[Motion SFC Monitor] 560 KB 1040 KB

[Motion SFC Monitor]
[R Motion SFC Monitor] 836 KB 1424 KB

[Q Motion SFC Monitor] 560 KB 1040 KB

[FX list editor] 580 KB 1080 KB

[CC-Link IE TSN/CC-Link IE Field Network diagnostics] 920 KB 2618 KB

[Vision Sensor Monitor] 1303 KB 31235 KB

[Recipe Operation] 112 KB 430 KB

[Recipe Display (Record List)] 60 KB 980 KB

[Operation log screen image] 105 KB 205 KB

[Operator Authentication] 620 KB 1020 KB

[File Manager] 210 KB 4405 KB

[File Print] 793 KB 20482 KB

[Document Display]

[Document Display (Document Converter)] 100 KB 4100 KB

[Document Display (PDF)] 5120 KB 35840 KB

[PDF Search/bookmark Function] 205 KB 825 KB

[MELSEC-L Troubleshooting Function] 320 KB 780 KB

[GOT Platform Library] 140 KB 200 KB

[GOT Function Expansion Library] 6724 KB 29620 KB

[GOT Function Expansion Library (Additional / MELSEC iQ-R / MELSEC iQ-L)] 5664 KB 4816 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Key Window Design Information]

When a basic-type or stylish-type screen design is used 1255 KB 2615 KB

When a dark-tone-flat-type or light-tone-flat-type screen design 
is used 567 KB 2103 KB

[Base Screen Size Expansion] 40 KB 60 KB

[Standard Font]

[Japanese] 460 KB 1440 KB

[Chinese(Simplified)] 320 KB 960 KB

[Chinese(Traditional)] 500 KB 1300 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 450 KB 800 KB

[Japanese(Kanji)] 1150 KB 1980 KB

[Chinese(Simplified)]
(Character code: [GB2312])

600 KB 960 KB

[Chinese(Simplified)]
(Character code: [GBK])

1600 KB 2140 KB

[Chinese(Traditional)] 1100 KB 1800 KB

[Hangul] 300 KB 840 KB

[Kaisho]

[Alphanumeric/Kana] 510 KB 928 KB

[Japanese(Kanji)] 1200 KB 1853 KB

[Chinese(Simplified)]
(Character code: [GB2312])

570 KB 960KB

[Chinese(Simplified)]
(Character code: [GBK])

1780 KB 2340 KB

[Chinese(Traditional)] 1400 KB 2070 KB

[Hangul] 300 KB 870 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[Kana-Kanji/Pinyin Conversion]

When [Kana-Kanji] is selected in the [Environmental Setting] 
window ([Kana-Kanji/Pinyin Conversion]) 1001 KB 1800 KB

When [Pinyin Simplified Characters] is selected in the 
[Environmental Setting] window ([Kana-Kanji/Pinyin 
Conversion])

2128 KB 3245 KB

[Wireless LAN] 600 KB 512 KB

[SoftGOT-GOT Link Function] 40 KB 200 KB

[System Launcher]
[System Launcher (Basic)] 701 KB 2309 KB

[System Launcher (Servo Network)] 330 KB 1530 KB

[iQSS Utility] 631 KB 1613 KB

[Network Drive] 883 KB 2565 KB

[Sequence Program Monitor]

[Sequence Program Monitor(Ladder)] 970 KB 2620 KB

[Sequence Program Monitor(iQ-R/iQ-L Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(iQ-F Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(SFC)] 740 KB 1420 KB

[FX Ladder Monitor] 760 KB 760 KB

[Backup/Restoration] 320 KB 860 KB

[Gateway]

[Gateway(Server, Client)] 200 KB 500 KB

[Gateway(Mail)] 128 KB 500 KB

[Gateway(FTP Server)] 60 KB 400 KB

[File Transfer] 40 KB 2100 KB

[Barcode]
[Bar Code (Serial)] 40 KB 100 KB

[Bar Code (USB)] 40 KB 100 KB

[RFID] 40 KB 100 KB

[PC Remote Operation(Ethernet)]
[Graphics Setting] is set to [GOT Graphic Ver.2] 345 KB 6640 KB

[Graphics Setting] is set to [GOT Graphic Ver.1] 200 KB 4440 KB

[VNC Server] 280 KB 5140 KB

[External I/O / Operation Panel] 80 KB 100 KB

[Report] 50 KB 100 KB

[Printer]

[Printer(PictBridge)] 260 KB 1110 KB

[Printer(Serial)] 80 KB 200 KB

[Printer(ESC/P-R)] 100 KB 3072 KB

[Printer(PCL5)] 100 KB 3072 KB

[Sound Output] 100 KB 200 KB

[GOT Network Interaction] 100 KB 977 KB

[GOT Mobile Function] 4904 KB 13693 KB

[Device Data Transfer] 40 KB 100 KB

[Hard Copy PDF Output] 280 KB 20992 KB

[MES Interface] 512 KB 500 KB

[Device monitor] 400 KB 1180 KB

[Network monitor] 260 KB 340 KB

[Log Viewer] 1240 KB 3800 KB

[Intelligent module monitor] 460 KB 620 KB

[Servo amplifier monitor] 660 KB 680 KB

[Drive Recorder] 780 KB 2918 KB

[Servo amplifier graph] 860 KB 11410 KB

[R motion monitor] 600 KB 1500 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(9) Extended function (GT23)

[Q motion monitor] 720 KB 660 KB

[CNC Monitor] 600 KB 1500 KB

[CNC Data I/O] 310 KB 880 KB

[CNC Machining Program Edit] 290 KB 738 KB

[CNC Monitor 2] 350 KB 2700 KB

[Motion Program Editor] 310 KB 760 KB

[Motion Program Input/Output] 810 KB 1110 KB

[Motion SFC Monitor]
[R Motion SFC Monitor] 836 KB 1424 KB

[Q Motion SFC Monitor] 560 KB 1040 KB

[FX list editor] 580 KB 1080 KB

[CC-Link IE TSN/CC-Link IE Field Network diagnostics] 920 KB 2618 KB

[Vision Sensor Monitor] 1303 KB 31235 KB

[Recipe Operation] 112 KB 430 KB

[Recipe Display (Record List)] 60 KB 980 KB

[Operation log screen image] 105 KB 205 KB

[Operator Authentication] 620 KB 1020 KB

[File Manager] 210 KB 4405 KB

[File Print] 793 KB 20482 KB

[Document Display]

[Document Display (Document Converter)] 100 KB 4100 KB

[Document Display (PDF)] 5120 KB 35840 KB

[PDF Search/bookmark Function] 205 KB 825 KB

[MELSEC-L Troubleshooting Function] 320 KB 780 KB

[GOT Platform Library] 140 KB 200 KB

[GOT Function Expansion Library] 6724 KB 29620 KB

[GOT Function Expansion Library (Additional / MELSEC iQ-R / MELSEC iQ-L)] 5664 KB 4816 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Standard Font]

[Japanese] 287 KB 959 KB

[Chinese(Simplified)] 307 KB 959 KB

[Chinese(Traditional)] 486 KB 1286 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 450 KB 800 KB

[Japanese(Kanji)] 1150 KB 1980 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 600 KB 960 KB

[Chinese(Simplified)]
(Character code: [GBK]) 1600 KB 2140 KB

[Chinese(Traditional)] 1100 KB 1800 KB

[Hangul] 300 KB 840 KB

[Kaisho]

[Alphanumeric/Kana] 510 KB 928 KB

[Japanese(Kanji)] 1200 KB 1853 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 570 KB 960KB

[Chinese(Simplified)]
(Character code: [GBK]) 1780 KB 2340 KB

[Chinese(Traditional)] 1400 KB 2070 KB

[Hangul] 300 KB 870 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(10)Extended function (GT21)

[System Launcher] 701 KB 2309 KB

[Backup/Restoration] 320 KB 840 KB

[Gateway]
[Gateway(FTP Server)] 60 KB 400 KB

[File Transfer] 40 KB 400 KB

[Barcode]
[Bar Code (Serial)] 40 KB 100 KB

[Bar Code (USB)] 40 KB 100 KB

[RFID] 20 KB 60 KB

[Report] 50 KB 100 KB

[Printer]
[Printer(Serial)] 80 KB 200 KB

[Printer(ESC/P-R)] 100 KB 3072 KB

[GOT Network Interaction] 100 KB 977 KB

[Device Data Transfer] 40 KB 100 KB

[Device monitor] 400 KB 1180 KB

[FX list editor] 140 KB 340 KB

[Recipe Operation] 112 KB 430 KB

[Recipe Display (Record List)] 60 KB 980 KB

[Operation log screen image] 105 KB 205 KB

[Operator Authentication] 615 KB 1020 KB

[File Manager] 210 KB 4405 KB

[File Print] 793 KB 2869.2 KB

[GOT Platform Library] 140 KB 200 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Standard Font]

[Japanese] 0 KB 0 KB

[Chinese(Simplified)] 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 0 KB 0 KB

[Japanese(Kanji)] 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GBK]) 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Hangul] 0 KB 0 KB

[Kaisho]

[Alphanumeric/Kana] 0 KB 0 KB

[Japanese(Kanji)] 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GBK]) 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Hangul] 0 KB 0 KB

[Kana-Kanji/Pinyin Conversion]

When [Kana-Kanji] is selected in the [Environmental Setting] 
window ([Kana-Kanji/Pinyin Conversion]) 0 KB 0 KB

When [Pinyin Simplified Characters] is selected in the 
[Environmental Setting] window ([Kana-Kanji/Pinyin 
Conversion])

0 KB 0 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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(11)Extended function (GS25)

[VNC Server] 0 KB 0 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Key Window Design Information]

When a basic-type or stylish-type screen design is used 1255 KB 2615 KB

When a dark-tone-flat-type or light-tone-flat-type screen design 
is used 567 KB 2103 KB

[Base Screen Size Expansion] 40 KB 60 KB

[Standard Font]

[Japanese] 460 KB 1440 KB

[Chinese(Simplified)] 320 KB 960 KB

[Chinese(Traditional)] 500 KB 1300 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 450 KB 800 KB

[Japanese(Kanji)] 1150 KB 1980 KB

[Chinese(Simplified)]
(Character code: [GB2312])

600 KB 960 KB

[Chinese(Simplified)]
(Character code: [GBK])

1600 KB 2140 KB

[Chinese(Traditional)] 1100 KB 1800 KB

[Hangul] 300 KB 840 KB

[Kaisho]

[Alphanumeric/Kana] 510 KB 928 KB

[Japanese(Kanji)] 1200 KB 1853 KB

[Chinese(Simplified)]
(Character code: [GB2312])

570 KB 960KB

[Chinese(Simplified)]
(Character code: [GBK])

1780 KB 2340 KB

[Chinese(Traditional)] 1400 KB 2070 KB

[Hangul] 300 KB 870 KB

[Kana-Kanji/Pinyin Conversion]

When [Kana-Kanji] is selected in the [Environmental Setting] 
window ([Kana-Kanji/Pinyin Conversion]) 1001 KB 1800 KB

When [Pinyin Simplified Characters] is selected in the 
[Environmental Setting] window ([Kana-Kanji/Pinyin 
Conversion])

2128 KB 3245 KB

[Wireless LAN] 600 KB 512 KB

[SoftGOT-GOT Link Function] 40 KB 200 KB

[System Launcher]
[System Launcher (Basic)] 701 KB 2309 KB

[System Launcher (Servo Network)] 330 KB 1530 KB

[iQSS Utility] 631 KB 1613 KB

[Network Drive] 883 KB 2565 KB

[Sequence Program Monitor]

[Sequence Program Monitor(Ladder)] 970 KB 2620 KB

[Sequence Program Monitor(iQ-R/iQ-L Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(iQ-F Ladder)] 2390 KB 4590 KB

[Sequence Program Monitor(SFC)] 740 KB 1420 KB

[FX Ladder Monitor] 760 KB 760 KB

[Backup/Restoration] 320 KB 860 KB

[Gateway]

[Gateway(Server, Client)] 200 KB 500 KB

[Gateway(Mail)] 128 KB 500 KB

[Gateway(FTP Server)] 60 KB 400 KB

[File Transfer] 40 KB 2100 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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[Barcode]
[Bar Code (Serial)] 40 KB 100 KB

[Bar Code (USB)] 40 KB 100 KB

[RFID] 40 KB 100 KB

[PC Remote Operation(Ethernet)]
[Graphics Setting] is set to [GOT Graphic Ver.2] 345 KB 6640 KB

[Graphics Setting] is set to [GOT Graphic Ver.1] 200 KB 4440 KB

[VNC Server] 280 KB 5140 KB

[External I/O / Operation Panel] 80 KB 100 KB

[Report] 50 KB 100 KB

[Printer]

[Printer(PictBridge)] 260 KB 1110 KB

[Printer(Serial)] 80 KB 200 KB

[Printer(ESC/P-R)] 100 KB 3072 KB

[Printer(PCL5)] 100 KB 3072 KB

[Sound Output] 100 KB 200 KB

[GOT Network Interaction] 100 KB 977 KB

[GOT Mobile Function] 4904 KB 13693 KB

[Device Data Transfer] 40 KB 100 KB

[Hard Copy PDF Output] 280 KB 20992 KB

[MES Interface] 512 KB 500 KB

[Device monitor] 400 KB 1180 KB

[Network monitor] 260 KB 340 KB

[Log Viewer] 1240 KB 3800 KB

[Intelligent module monitor] 460 KB 620 KB

[Servo amplifier monitor] 660 KB 680 KB

[Drive Recorder] 780 KB 2918 KB

[Servo amplifier graph] 860 KB 11410 KB

[R motion monitor] 600 KB 1500 KB

[Q motion monitor] 720 KB 660 KB

[CNC Monitor] 600 KB 1500 KB

[CNC Data I/O] 310 KB 880 KB

[CNC Machining Program Edit] 290 KB 738 KB

[CNC Monitor 2] 350 KB 2700 KB

[Motion Program Editor] 310 KB 760 KB

[Motion Program Input/Output] 810 KB 1110 KB

[Motion SFC Monitor]
[R Motion SFC Monitor] 836 KB 1424 KB

[Q Motion SFC Monitor] 560 KB 1040 KB

[FX list editor] 580 KB 1080 KB

[CC-Link IE TSN/CC-Link IE Field Network diagnostics] 920 KB 2618 KB

[Vision Sensor Monitor] 1303 KB 31235 KB

[Recipe Operation] 112 KB 430 KB

[Recipe Display (Record List)] 60 KB 980 KB

[Operation log screen image] 105 KB 205 KB

[Operator Authentication] 620 KB 1020 KB

[File Manager] 210 KB 4405 KB

[File Print] 793 KB 20482 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
12. APPENDICES
12.10 Data Transferred to the GOT and Storage Destination

12 - 765



(12)Extended function (GS21)

[Document Display]

[Document Display (Document Converter)] 100 KB 4100 KB

[Document Display (PDF)] 5120 KB 35840 KB

[PDF Search/bookmark Function] 205 KB 825 KB

[MELSEC-L Troubleshooting Function] 320 KB 780 KB

[GOT Platform Library] 140 KB 200 KB

[GOT Function Expansion Library] 6724 KB 29620 KB

[GOT Function Expansion Library (Additional / MELSEC iQ-R / MELSEC iQ-L)] 5664 KB 4816 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Standard Font]

[Japanese] 0 KB 0 KB

[Chinese(Simplified)] 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Outline Font]

[Gothic]

[Alphanumeric/Kana] 0 KB 0 KB

[Japanese(Kanji)] 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GBK]) 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Hangul] 0 KB 0 KB

[Kaisho]

[Alphanumeric/Kana] 0 KB 0 KB

[Japanese(Kanji)] 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GB2312]) 0 KB 0 KB

[Chinese(Simplified)]
(Character code: [GBK]) 0 KB 0 KB

[Chinese(Traditional)] 0 KB 0 KB

[Hangul] 0 KB 0 KB

[Kana-Kanji/Pinyin Conversion]

When [Kana-Kanji] is selected in the [Environmental Setting] 
window ([Kana-Kanji/Pinyin Conversion]) 0 KB 0 KB

When [Pinyin Simplified Characters] is selected in the 
[Environmental Setting] window ([Kana-Kanji/Pinyin 
Conversion])

0 KB 0 KB

[VNC Server] 0 KB 0 KB

Extended function
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)
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■2 Data size of special data

The data size in the user area varies with the selection for [Language] in the [Application Selection] dialog.
➟(1) [Japanese]
(2) [English]

(1) [Japanese]

(2) [English]

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Special Data
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Intelligent module monitor data] 13294KB 13294KB

[R motion monitor data] 292KB 292KB

[Q motion monitor data] 606KB 606KB

[Servo amplifier monitor data] 273KB 273KB

Special Data
Data size in the user area

Built-in flash 
memory (ROM)

User memory 
(RAM)

[Intelligent module monitor data] 13761KB 10067KB

[R motion monitor data] 321KB 98KB

[Q motion monitor data] 639KB 552KB

[Servo amplifier monitor data] 273KB 196KB
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12.11 Specifications of Resource Data

➟12.11.1 Common specifications of CSV files and Unicode text files
12.11.2 Size of the resource data file

12.11.1 Common specifications of CSV files and Unicode text files

Binary files created using the following functions can be viewed on a personal computer when the files are converted to 
CSV files or Unicode text files.

• User alarm observation
• System alarm observation
• Logging
• Recipe
• Operation log

The following shows the specifications of the file formats.

12.11.2 Size of the resource data file

Some functions of the GOT store the resource data into a data storage.
The following shows the expressions for calculating the size of the resource data to be stored into a data storage by each 
function.
The sizes determined by the expressions are approximate.
A determined size may be different from the actual size of the resource data.

➟■1 User alarm observation
■2 System Alarm Observation
■3 Logging
■4 Recipe
■5 Operation Log
■6 Hard copy
■7 MES interface function
■8 Label name resolution information

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

File format Specifications

CSV format (*.CSV)

• Character codes: ASCII and Shift JIS
• Delimiter: Comma (,)

Before converting a data file containing any character other than the ASCII and Shift JIS code 
characters to a CSV file, turn on GS522.b2.
Then, the file is converted to a file with an extension of CSV in the following specifications, and the 
characters are correctly displayed.
• Character codes: Unicode
• Delimiter: Tab

➟12.1.3 ■5 (60) Special Control During Specific Function Execution (GS522)

Unicode text format (*.TXT)
• Character codes: Unicode
• Delimiter: Tab

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
12 - 768 12. APPENDICES
12.11 Specifications of Resource Data



A
PP

EN
D

IC
ES

12
■1 User alarm observation
(1) Binary file (*.G2A)
(a) Historical mode

144 + (A × 2) + (18 × B) + (20 × C) bytes
• A: Number of characters of the alarm name
• B: Number of alarms
• C: Number of stored events

(b) Cumulative mode (when [Display the same alarm occurring multiple times as another item] is 
deselected)
144 + (A × 2) + (48 × B) bytes

• A: Number of characters of the alarm name
• B: Number of alarms

(c) Cumulative mode (when [Display the same alarm occurring multiple times as another item] is 
selected)
144 + (A × 2) + (26 × B) + (32 × C) bytes

• A: Number of characters of the alarm name
• B: Number of alarms
• C: Number of stored events

(2) CSV file
(a) Historical mode

422 + (A × 2) + (14 + B + C + D + (E × 2) + (F × 3) + G + H) × I byte
• A: Number of characters of the alarm name
• B: Number of digits of the upper comment No.
• C: Number of digits of the middle comment No.
• D: Number of digits of the basic alarm comment No.
• E: Average number of characters of comments
• F: Length of the date and time string
• G: Number of digits of the level
• H: Number of digits of the group
• I: Number of alarms

When counting the number of characters in an alarm name or the average number of characters in a comment, count a 
one-byte character as 0.5 character and a two-byte character as 1 character.

(b) Cumulative mode
457 + (A × 2) + (39 + B + C + D + (E × 2) + (F × 3) + G + H + I) × J bytes

• A: Number of characters of the alarm name
• B: Number of digits of the upper comment No.
• C: Number of digits of the middle comment No.
• D: Number of digits of the basic alarm comment No.
• E: Average number of characters of comments
• F: Length of the date and time string
• G: Number of digits of the level
• H: Number of digits of the group
• I: Number of digits of the frequency of alarm occurrences
• J: Number of alarms

When counting the number of characters in an alarm name or the average number of characters in a comment, count a 
one-byte character as 0.5 character and a two-byte character as 1 character.

(3) Unicode text file
Size of the CSV file × 2 bytes
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■2 System Alarm Observation
(1) Binary file (*.G2A)
(a) When [Get detailed alarm information] is deselected

128 + (24 × A) bytes
• A: Number of stored events

(b) When [Get detailed alarm information] is selected
128 + (52 × A) bytes

• A: Number of stored events

(2) CSV file
447 + (20 + A + (B × 2) + C + D + E + F + G + H + I + (J × 2) + K) × L bytes
• A: Average number of digits of alarm numbers
• B: Average number of characters of comments
• C: Length of the data and time string
• D: Number of digits of the channel No.
• E: Number of characters of the network No., station No., and module No.
• F: Number of characters of the device name
• G: Number of digits of the screen No.
• H: Number of digits of the definition screen No.
• I: Number of digits of the object ID
• J: Number of characters of the function name
• K: Number of characters of the drive name
• L: Number of alarms
When counting the average number of characters in a comment or the number of characters in a function name, count a 
one-byte character as 0.5 character and a two-byte character as 1 character.

(3) Unicode text file
Size of the CSV file × 2 bytes
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■3 Logging
(1) Binary file (*.G2L)

152 + A + B + D + E + F + G bytes
The following describes characters A to S used in the mathematical expressions.

*1 Rounded up to a multiple of 4.

(2) CSV file
215 + A + D × F bytes
The following describes characters A to F used in the mathematical expressions.

(3) Unicode text file
Size of the CSV file × 2 bytes

Character Description

A *1 2 + 2 × Number of characters used in [Logging Name]

B *1 C × Total device points set in each block in the [Device] tab

C *1 2 + 2 × Number of characters used in [Device Comment]

D 4 × Total device points set in each block in the [Device] tab

E 12 × Number of blocks

F 4 × Number of blocks

G H × Number of logs per file

H 4 + J + K

J *1 2 + ( (L × 2) + 7) / 8 

K *1 L × 2

L M + N + P + Q + R × 2 + S × 4

M Total device points set in the blocks when the device type is as follows:
[Bit]

N Total device points set in the blocks when the device type is as follows:
[Signed BIN8] or [Unsigned BIN8]

P Total device points set in the blocks when the device type is as follows:
[Signed BIN16], [Unsigned BIN16], or [BCD16]

Q Total device points set in the blocks when the device type is as follows:
[String]

R Total device points set in the blocks when the device type is as follows:
[Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)]

S Total device points set in the blocks when the device type is as follows:
[Signed BIN64], [Unsigned BIN64], [BCD64], or [Real(64bit)]

Character Description

A (B + 17) × C

B Average number of characters of device comments

C Total number of the devices set to the block

D 20 + (E + 1) × C

E Number of displayed digits
Add 5 when the digits are displayed in real type (exponential expression).
Apply this number when the digits are displayed in real type (fixed decimal) and decimal places are 0.
Add the number of decimal places and 1 when the digits are displayed in real type (fixed type) and decimal places are 1 or higher.

F Number of logs in the file
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■4 Recipe
(1) Binary file (*.G2P)

216 + 16 × A + 4 × B + C + D × M bytes
The following describes characters A to M used in the mathematical expressions.

*1 Rounded up to a multiple of 4.

(2) CSV file
240 + A + B + H bytes
The following describes characters A to J used in the mathematical expressions.

(3) Unicode text file
Size of the CSV file × 2 bytes

Character Description

A Value set for [Block Number] in the [Device] tab

B Total device points set in each block in the [Device] tab

C *1 (2 + (2 × Number of characters)) × B

D *1 80 + E × 2

E F + G + H + J + K × 2 + L × 4

F Total device points set in the blocks when the device type is as follows:
[Bit]

G Total device points set in the blocks when the device type is as follows:
[Signed BIN8] or [Unsigned BIN8]

H Total device points set in the blocks when the device type is as follows:
[Signed BIN16], [Unsigned BIN16], or [BCD16]

J Total device points set in the blocks when the device type is as follows:
[String]

K Total device points set in the blocks when the device type is as follows:
[Signed BIN32], [Unsigned BIN32], [BCD32], or [Real(32bit)]

L Total device points set in the blocks when the device type is as follows:
[Signed BIN64], [Unsigned BIN64], [BCD64], or [Real(64bit)]

M Value set for [Record Number] in the [Device] tab

Character Description

A Number of characters of the record name

B (C + D + E + F) × (18 + G)

C Number of bit devices

D Number of word devices

E Number of double-word devices

F Number of blocks with the device type [Text]

G Number of characters of the device comment

H I × (25 + C × 2 + D × 7 + E × 12 + F × 2)

I Number of records
(when the recipe file format is CSV or Unicode text, regardless of the recipe settings: the number of records = 1)

J Total number of words in devices (with the device type [Text])
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■5 Operation Log
(1) Binary file (*.G2O)

64 + (N1 + N2 + ... + Nm) bytes
"N1 + N2 + ... + Nm" indicates the total size of each log.
The following table shows the size per log for each log type.

Log type Size (byte) Log type Size (byte)

GOT startup Max.88 Touch switch: Application switching Max.256 

GOT termination 12 Touch switch: Screen switching Max.260  

GOT simple restart 12 Touch switch: Station No. switching Max.260

GOT project restart 12 Touch switch: Auto repeat start Max.256 

GOT restart by reset 12 Touch switch: Auto repeat end Max.260 

GOT offline mode transition 12 Touch switch: Screen gesture Max.256

GOT background processing stop 12 Touch switch: Recipe operation import Max.420

GOT background processing restart 12 Touch switch: Recipe operation export Max.420

Application switching 16 Numerical input: Base device Max.456 

Application startup, exit 20 Numerical input: Option write device Max.276 

Clock setting (External device to GOT) 16 Numerical input: Option write completion device Max.276 

Clock setting (SNTP) 16 Text input Max.1080 

Clock setting (GS) 16 Text input: Option write completion device Max.276 

Time zone change 24 Alarm display (list, history): User alarm deletion Max.256 

Displayed system language Max.48 Alarm display (list, history): Deletion of all the user alarms Max.256 

Screen switching Max.84 Alarm display (list, history): System alarm deletion Max.256 

Station No. switching 16 Alarm display (list, history): Deletion of all the system alarms Max.256 

Switching between languages 16 Alarm display (list, history): System alarm reset Max.256 

Buffer memory unit No. switching 16 Alarm display (list, history): User alarm reset Max.288 

Security level change (Device value change) 16 Slider control Max.336 

SoftGOT-GOT link connection 16 Recipe display (record list): Record name change Max.396

SoftGOT-GOT link disconnection 16 Recipe display (record list): Read Max.328

SoftGOT-GOT link authorization transfer 20 Recipe display (record list): Write Max.328

VNC server connection 16 Recipe display (record list): Deletion Max.328

VNC server disconnection 16 Object script (trigger type [Key Code Input]) Max.280

VNC server authorization transfer 20 Operator authentication: Login successful Max.36 

Screen gesture 20 Operator authentication: Login/re-login failed Max.36 

System language switching Max.72 Operator authentication: Logout Max.36 

Security level change (Password entry) Max.40 Operator authentication: Automatic logout Max.36 

Clock function (changed in the utility) Max.40 Operator authentication: Forced logout Max.36 

Time zone change (in the utility) Max.48 Operator authentication: Operator switching successful Max.36 

GOT No. switching Max.40 Operator authentication: Operator switching failed Max.36 

Touch switch: Bit set Max.280 Operator authentication: Password changed Max.36 

Touch switch: Bit reset Max.280 Operator authentication: Password change failed Max.36 

Touch switch: Bit alternate Max.280 Operator authentication: Operator account lock Max.32

Touch switch: Bit momentary Max.280 Operator management: Started Max.40

Touch switch: Word set Max.288 Operator management: Start failed Max.40
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Log type Size (byte) Log type Size (byte)

Operator management: End Max.40 File print: Aborted (User) Max.188

Operator management operation: Save Max.36 File print: Complete Max.164

Operator management operation: Undo Max.36 File print: Aborted (Access error) Max.164

Operator management operation: Import Max.196 File print: Aborted (Printer error) Max.164

Operator management operation: Export Max.196 File print: Aborted (Timeout error) Max.164

Operator management changed (function settings): 
Authentication type

Max.44 File print: Aborted (System) Max.164

Operator management changed (function settings): Automatic 
logout

Max.44 Network drive connection Max.208

Operator management changed (function settings): Password 
expiration date

Max.48 Network drive connection failed Max.208

Operator management changed (function settings): External 
authentication ID

Max.48 GOT Mobile: Connection established Max.295

Operator management changed (function settings): 
Authentication prohibited

Max.48 GOT Mobile: Trial connection established Max.295

Operator management changed (function settings): Operator 
account lock

Max.44 GOT Mobile: Connection authentication failed Max.295

Operator management changed (function settings): Password 
requirements

Max.48 GOT Mobile: Number of clients exceeded the upper limit Max.295

Operator management changed (function settings): Password 
history

Max.44 GOT Mobile: Disconnection 20

Operator management changed (function settings): Sub 
administrator

Max.44 GOT Mobile: Forced disconnection (Control information) 20

Operator management changed (operator management): 
Addition of operator

Max.64 GOT Mobile: End of trial connection 20

Operator management changed (operator management): 
Deletion of operator

Max.64 GOT Mobile: Abnormal disconnection due to a communication 
error

20

Operator management changed (operator management): 
Editing of operator

Max.68 GOT Mobile: Virtual device allocation 48

Operator management (at startup): New file creation Max.12 Authorization management: Obtained 20

Operator management (at startup): File corruption Max.12 Authorization management: Released 20

Operator management (at startup): Corrupted file restoration Max.40 Authorization use: Obtained 44

Operator management (at startup): Abnormal end Max.40 Authorization use: Released 44

Functional operation security Max.44 Authorization use: Failed to obtain 44

File print: Start Max.188
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(2) CSV file
248 + (N1 + N2 + ... + Nm) bytes
"N1 + N2 + ... + Nm" indicates the total size of each log.
The following table shows the size per log for each log type.

(3) Unicode text file
Size of the CSV file × 2 bytes

Log type Size (byte) Log type Size (byte)

GOT startup 154 Numerical input (Write completion device) 227

GOT termination 93 Text input: Option write completion device 588

GOT simple restart 103 Text input 152

GOT project restart 112 User alarm (Deletion) 174

GOT restart by reset 108 User alarm (Deletion of all the user alarms) 176

GOT offline mode transition 113 User alarm (Reset) 195

GOT background processing stop 116 System alarm (Deletion) 174

GOT background processing restart 118 System alarm (Deletion of all the system alarms) 176

Application switching 139 System alarm (Reset) 195

Application start 128 Slider control 151

Application termination 126 Recipe display (record list): Record name change 180

Time setting (External device) 182 Recipe display (record list): Read 161

Time setting (SNTP) 179 Recipe display (record list): Write 161

Time setting (GS) 176 Recipe display (record list): Deletion 168

Time zone change 125 Object script 218

System language switching (Device) 115 Operator authentication: Login 119

Screen switching 193 Operator authentication: Login failed 119

Station No. switching 129 Operator authentication: Logout 123

Switching between languages 103 Operator authentication: Automatic logout 128

Buffer memory unit No. switching 118 Operator authentication: Forced logout 128

Level change (Device) 111 Operator authentication: Operator switching successful 125

SoftGOT-GOT link 125 Operator authentication: Operator switching failed 127

VNC server connection 114 Operator authentication: Password changed 116

Screen gesture 114 Operator authentication: Password change failed 128

System language switching 171 Operator authentication: Operator account lock 117

Level change (Password) 167 Operator management: Started 162

Time change 224 Operator management: Start failed 167

GOT No. switching 169 Operator management: End 160

Touch switch (Bit) 205 Operator management operation: Save 160

Touch switch (Word) 247 Operator management operation: Undo 160

Special function switch 171 Operator management operation: Import 239

Go To Screen switch 195 Operator management operation: Export 226

Change station No. switch 193 Operator management changed (Function settings) 160

Touch switch (Auto repeat start) 193 Operator management changed (Operator management) 381

Touch switch (Auto repeat end) 198 Operator management (at startup) 182

Touch switch: Screen gesture 149 Functional operation security 182

Touch switch: Recipe operation import 243 File print 239

Touch switch: Recipe operation export 243 Network drive connection 181

Numerical input 228 GOT Mobile connection/disconnection 197

Numerical input (Write device) 221 Authorization management obtained/released 189
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■6 Hard copy
(1) BMP file

The file size depends on the resolution of the GOT.

(2) JPEG file
The file size depends on the contents displayed on the GOT screen.

■7 MES interface function

■8 Label name resolution information
The following shows the size of the label name resolution file by channel.
 56 + (A × 52) + (B × 98) + (C × 2) bytes
• A: Number of the monitored controllers per CPU No. by channel
• B: Total number of the labels by channel used on the GOT
• C: Total number of characters of the labels by channel used on the GOT

GOT resolution Size (byte)

WXGA (1280×800) 3072054

XGA (1024 × 768) 2359350

SVGA (800 × 600) 1440054

WVGA (800×480) 1152054

VGA (640 × 480) 921654

QVGA (320 × 240) 230454

480 × 272 dots 391734

384 × 128 dots 147510

320 × 128 dots 122934

File Size

Execution log file Max. 512 K bytes per file

Event log file of the job execution Max. 1 M byte per file
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12.12 Specifications of the SRAM user area

Some functions of the GOT use the SRAM user area.
For functions that use the SRAM user area and the size of data stored in the SRAM user area, refer to the following.

➟12.12.1 Functions that use the SRAM user area
12.12.2 Size of data stored in the SRAM user area

12.12.1 Functions that use the SRAM user area

The following functions save data to the SRAM user area.
• User alarm observation
• System alarm observation
• Logging function
• Recipe function
• Internal device retention

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Applicable function Number of settings Size

User alarm observation Max. 10

500 KB (total)

System alarm observation Max. 1

Logging function Max. 20

Recipe function Max. 20

Internal device retention Max. 1

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.12.2 Size of data stored in the SRAM user area

Some functions of the GOT use the SRAM user area.
The following shows the expressions for calculating the size of the SRAM user area used by each function.

➟■1 User alarm observation
■2 System Alarm Observation
■3 Logging
■4 Recipe
■5 Internal device retention

The expressions only determine the approximate sizes.
The actual sizes may differ.
Check the actual sizes in the following setting dialogs.

➟9.1.2 ■7 [User Alarm Observation] dialog
9.1.3 ■5 [System Alarm Observation] dialog
9.2.7 [Logging] dialog (traditional display)
9.3.7 [Recipe] dialog
5.2.12 ■3 [Internal Device Retention]

■1 User alarm observation
(1) Current alarm only

256 + (16 × A) bytes
• A: Number of alarms

(2) Historical mode
256 + (2 × A) + (20 × B) bytes
• A: Number of alarms
• B: Number of stored events

(3) Cumulative mode (when [Display the same alarm occurring multiple times as another item] is 
deselected)
256 + (32 × A) bytes
• A: Number of alarms

(4) Cumulative mode (when [Display the same alarm occurring multiple times as another item] is 
selected)
256 + (12 × A) + (32 × B) bytes
• A: Number of alarms
• B: Number of stored events

■2 System Alarm Observation
(1) Current alarm only (when [Get detailed alarm information] is deselected)

256 + (20 × A) bytes
• A: Number of stored events

(2) Current alarm only (when [Get detailed alarm information] is selected)
256 + (48 × A) bytes
• A: Number of stored events

(3) Historical mode (when [Get detailed alarm information] is deselected)
256 + (24 × A) bytes
• A: Number of stored events

(4) Historical mode (when [Get detailed alarm information] is selected)
256 + (52 × A) bytes
• A: Number of stored events

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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■3 Logging
192 + (4 × A) + (B × E) bytes

• A: Number of blocks
• B: 10 + ((C + (D × 2)) × (9/4))
• C: Total number of blocks (with the device types [Bit], [Signed BIN16], [Unsigned BIN16], [BCD16] and [String])
• D: Total number of blocks (with the device types [Signed BIN32], [Unsigned BIN32], [BCD32], and [Real])
• E: Number of stored logs

■4 Recipe
256 + (16 × A) + (B × E) bytes

• A: Number of blocks
• B: 80 + ((C + D × 2) × 2)
• C: Total number of blocks (with the device types [Bit], [Signed BIN16], [Unsigned BIN16], [BCD16] and [String])
• D: Total number of blocks (with the device types [Signed BIN32], [Unsigned BIN32], [BCD32], and [Real])
• E: Number of records

■5 Internal device retention
(192 + ("A" rounded up to a multiple of 64) × 2

• A: 44 + B + D
• B: 32 + (2 × C)
• C: Number of GOT data registers (GD)

If C is 0, B is not added.
• D: 32 + 4 × ((E / 32) - (F / 32) + 1)

In the result of (E / 32) and (F / 32), the numbers after the decimal point are omitted.
• E: F + G - 1
• F: Start device number of GOT bit registers (GB)
• G: Number of GOT data registers (GD)

If G is 0, D is not added.
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12.13 Compatibility with Conventional Products

➟12.13.1 Compatibility of projects
12.13.2 Specifications of the project conversion from GOT1000 to GOT2000
12.13.3 Specifications of the project conversion from GOT2000 to GOT2000
12.13.4 Data copy between drawing software

12.13.1 Compatibility of projects

➟■1 Project that can be handled with GT Designer3
■2 Converting a project by changing the GOT type

■1 Project that can be handled with GT Designer3
The following shows each project format and the compatibility with GT Designer3.

*1 This format is a project format for writing to the data storage.
This format cannot be saved with the [Project] menu.

*2 There are two alternatives: convert a project into the GOT2000 equivalent, or start GT Designer3 (GOT1000) to edit the project 
with keeping a GOT1000 project.

*3 Open the project after converting into the GOT1000 equivalent by using GT Designer3 (GOT1000).
To edit the project as a GOT900 project, use GT Designer2 Classic.
To convert the project into the GOT2000 equivalent, convert the project into the GOT1000 equivalent in advance.

■2 Converting a project by changing the GOT type
You can change the opened project to another GOT project by changing the GOT type.

➟5.1 Changing the GOT Type of the Project ([GOT Type Setting])
GT Designer3 is compatible with the following project conversion.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Project format

Operation

Open
Save Utilize other projects

GT Designer3
(GOT2000)

GT Designer3
(GOT1000)

GT Designer3
(GOT2000)

GT Designer3
(GOT1000)

GOT2000 project

Workspace format ○ ○ × ○ ×

*.GTX ○ ○ × ○ ×

*.GTXS ○ ○ × ○ ×

*.G2 ○ ○*1 × × ×

*.GTCNV ○ × × × ×

GOT1000 project

Workspace format ○*2 × ○ × ○

*.GTW ○*2 × ○ × ○

*.G1
(Created with GT 
Designer3)

○*2 × ○*1 × ×

*.GTE ○*2 × × × ○

*.G1
(Created with GT 
Designer2)

○*2 × × × ×

GOT900 project *.GTD ○*3 × × × ×

Project before conversion
Project after conversion

GOT2000 project GOT1000 project

GOT2000 project The project can be converted. The project cannot be converted.

GOT1000 project The project can be converted. The project can be converted.
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12.13.2 Specifications of the project conversion from GOT1000 to GOT2000

The following shows the project settings after the GOT1000 project is converted into the GOT2000 project.
• Settings configured for both GOT1000 and GOT2000
The settings are held.

• Settings configured only for GOT2000
Default values are set.
(For some settings, default values are not set.)

• Settings configured only for GOT1000
The settings are deleted.

• Settings configured for both GOT1000 and GOT2000, but have difference
The settings are changed according to the setting specifications of GOT2000.

Device settings are changed as follows.
• Device settings for devices within the device range that is compatible with the GOT model after the conversion are held.
[??] is displayed for devices outside the device range for the GOT model after the conversion.

• When no network setting is configured for the GOT model after the conversion, the NW No. setting and the PLC station 
No. settings are deleted.

• All devices of all channels are converted as the devices of a controller set for CH1 after the conversion.

■1 Whole project
(1) Font

(2) Drive name

(3) Report screen
All the settings for the report screens are held.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Before conversion (setting for 
GOT1000) After conversion (setting for GOT2000) Specifications of the conversion

[Font] [Font]

• For converting the GOT type to GT27, GT25, GT23, GT 
SoftGOT2000, or GS25
[Stroke] is converted into [Outline Gothic].

• For converting the GOT type to GT2107-W or GS21-W-N
[Stroke] is converted into [Outline Gothic].

• For converting the GOT type to GT2105-Q, GT2104-R, 
GT2104-P, GT2103-P, or GS21-W
[Stroke] is converted into [16dot Standard].

Before conversion (setting for 
GOT1000) After conversion (setting for GOT2000) Specifications of the conversion

[Drive Name] [Drive Name]

The drive name is converted as below.
• [A:Standard Memory Card] is converted into [A:Standard SD 

Card].
• [B:Extended Memory Card] is converted into [B:USB Drive].
• [C:Built-in Flash Memory] is held.
• [D:Built-in SRAM] is converted into [X:Current Drive].

For converting the GOT type to GT2107-W, GT2105-Q, 
GT2104-R, or GT2104-P, the setting is held.

• [E:USB Memory] is converted into [E:USB Drive].
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■2 Screen
(1) Property of screens

(2) Report setting

■3 Common setting
(1) Script

■4 Precautions
(1) HQ font setting for the comment display

When a GOT1000 project created with GT Designer2 is converted into a GOT2000 project, the HQ font setting may not 
be migrated.
For the details, refer to the following Technical News.

➟Precautions when Replacing GOT1000 Series with GOT2000 Series(GOT-A-0061)

Before conversion (setting for 
GOT1000) After conversion (setting for GOT2000) Specifications of the conversion

[Screen No.] [Screen No.]

If [Display the screen of value stored in screen switching 
device +1] is enabled in [GOT Environmental Setting] ([Screen 
Switching/Windows]), all the screen numbers decrease by one 
after conversion.
If the item is disabled, the setting is held after conversion.

[Front Layer Transparent] [Front Layer Transparent Color] The settings are held.
For GT21 and GS21, the setting is deleted after conversion.

[Popup the display of advanced alarm] [Display alarms as popups] The settings are held.

[Specify the touch area] - The settings are deleted.

[Display alarm flow] [Display alarms as popups] The settings are held.

[Backlight] [Backlight]

• For converting GT1020 or GT1030 to GT21-P
The conversion result depends on the backlight color 
selected in [Type Setting].
When [Green/Red/Orange] is selected, [Green/White] is 
changed to [Green], and [Orange/Pink] is changed to 
[Orange].
When [White/Red/Pink] is selected, [Green/White] is 
changed to [White], and [Orange/Pink] is changed to [Pink].
Regardless of the selection, [Red] is held.

• For converting any other than GT1020 and GT1030 to GT21-
P
The setting is changed to [White].

• For converting GOT1000 series to any other than GT21-P
The settings are deleted.

[Blink Backlight] [Blink Backlight]

• For converting GT1020 or GT1030 to GT21-P
The settings are held.

• For converting any other than GT1020 and GT1030 to GT21-
P
The setting is changed to [None].

• For converting GOT1000 series to any other than GT21-P
The settings are deleted.

[Option Selection] [Option Selection]
The settings are held.
For GT23, GT21 (except GT2107-W), and GS21, the setting is 
deleted after conversion.

Before conversion (setting for 
GOT1000) After conversion (setting for GOT2000) Specifications of the conversion

- [Printer Language] [Japanese] is set.

Before conversion (setting for 
GOT1000) After conversion (setting for GOT2000) Specifications of the conversion

[Trigger Type] [Trigger Type]

• [Ordinary] is converted into [Sampling] (Cycle time: [1] x 100 
ms).

• [ON] is converted into [ON Sampling] (Cycle time: [1] x 100 
ms).

• [OFF] is converted into [OFF Sampling] (Cycle time: [1] x 100 
ms).
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12.13.3 Specifications of the project conversion from GOT2000 to GOT2000

The following shows the project settings after the GOT2000 project is converted into another GOT2000 project.
• Settings configured for both the GOT model before the conversion and the one after the conversion
The settings are held.

• Settings configured only for the GOT model after the conversion
Default values are set.

• Settings configured only for the GOT model before the conversion
The settings are deleted.

• Settings configured for both the GOT models before the conversion and after the conversion, but have difference
The settings are changed according to the setting specifications of the GOT model after the conversion.

For the GOT models compatible with each function, refer to the following.
➟1.1.3 List of the supported models for each function

12.13.4 Data copy between drawing software

You can edit data among the drawing software, such as copying and pasting, by using multiple drawing software.

■1 When using GT Designer3 (GOT2000)
Copying and pasting data among other GT Designer3 (GOT2000)s are available.
Copying and pasting data between GT Designer3 (GOT2000) and GT Designer3 (GOT1000) are unavailable.

■2 When using GT Designer3 (GOT1000)
Copying and pasting data among other GT Designer3 (GOT1000)s are available.
Copying and pasting data between GT Designer3 (GOT1000) and GT Designer3 (GOT2000) are unavailable.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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12.14 Data Compatibility between the Graphics Modes

➟12.14.1 Project conversion specifications when the graphics mode is changed to GOT Graphic Ver.2
12.14.2 Project conversion specifications when the graphics mode is changed to GOT Graphic Ver.1

12.14.1 Project conversion specifications when the graphics mode is changed to GOT 
Graphic Ver.2

The following shows the current settings to be changed or deleted after the setting of [Graphics Setting] is changed to 
[GOT Graphic Ver.2] in the [Type Setting] dialog.
The items available only in the new graphics mode are set to their default.
The screen design will be the basic black after the graphic mode change.
To change the screen design, select your preference in the [Screen Design] dialog.

➟2.4.3 [Screen Design] dialog

■1 Screen
(1) Screen properties (Base screen, window screen, and mobile screen)

■2 Common settings
(1) Type Setting

(2) Parts Setting

■3 Figure

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21
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Item Specifications after the graphics mode change

[Front Layer Transparent Color] (for base 
screens and window screens)

The setting of this item is deleted.
Setting the transparent color for the front layer is not available.

[Background Color] The setting of each item is migrated to the [Pattern] tab of the [Fill Effects] dialog.
However, the following cases exist depending on the settings made before the graphics mode 
change.
• If [None] has been selected for [Pattern], the settings of [Background Color], [Pattern], and 

[Pattern Color] are deleted.
• If [8] has been selected for [Pattern], the settings of [Background Color] and [Pattern] are 

deleted and the setting of [Pattern Color] is migrated to [Background Color].
• If [37] has been selected for [Pattern], the settings of [Pattern] and [Pattern Color] are deleted 

and the setting of [Background Color] is migrated to [Background Color].

[Pattern]

[Pattern color]

Item Specifications after the graphics mode change

[Enable the graphics accelerator to smooth the 
screen gesture and document display 
operations]

The setting of this item is deleted.
The graphics accelerator is not available.

[Enable the antialiasing to smooth jagged text 
edges]

This item is nonexistent.
Antialiasing is always enabled.

[Adjust object display order in GOT to the one in 
GT Designer3]

This item is nonexistent.
The object stacking order adjustment is always enabled.

Item Specifications after the graphics mode change

[Show overlapping areas of shapes in XOR 
when Display Mode of Parts Display is XOR]

The setting of this item is deleted.
The XOR synthesis is not available.

Item Specifications after the graphics mode change

Paint
The setting of this item is deleted.
The paint is not available.
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■4 Object
Item Specifications after the graphics mode change

Touch Switch
The setting of [Reverse Switch Area] is deleted.
Inverting the colors in the touch switch area is not available.

Lamp Area
The setting of this item is deleted.
The lamp area is not available.

Numerical display [Display Mode] is nonexistent.
The [Transparent] mode is applied.Numerical input

Comment display (bit) [Display Mode] is nonexistent.
The [Transparent] mode is applied.Comment display (word)

Bit Parts Display
[Display Mode] is nonexistent.
The [Replace] mode is applied.

Word Parts Display

Fixed Parts Display

Parts movement (bit)
[Display Mode] is nonexistent.
The [Movement] mode is applied.

Parts movement (word)

Parts movement (fixed)

Alarm Display (User) [Text color on cursor display] is nonexistent.
The [Reverse] mode is applied.Alarm Display (System)

Level object

The setting of [Boundary Color] is deleted.
As the boundary color setting is invalid, the level display does not appear in the figure 
accordingly.

To appropriately display the level object in GOT Graphic Ver.2, place a parts display on the 
level object.
For the setting, refer to the following.

➟8.23.2 How to use the level object (GOT Graphic Ver.2)

GOT Graphic Ver.1

[Boundary Color] is valid.

Level

Figure (in the same color as 
[Boundary Color])

GOT Graphic Ver.2

[Boundary Color] is invalid.

Level
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12.14.2 Project conversion specifications when the graphics mode is changed to GOT 
Graphic Ver.1

The following shows the current settings to be changed or deleted after the setting of [Graphics Setting] is changed to 
[GOT Graphic Ver.1] in the [Type Setting] dialog.
The items available only in the new graphics mode are set to their default.

■1 Screen
(1) Screen design

(2) Screen properties (Base screen, window screen, and mobile screen)

■2 Common settings
(1) Type Setting

■3 Object

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

Item Specifications after the graphics mode change

Design

Preset
If the selected design is available in GOT Graphic Ver.1, the design setting is migrated as-is.
If the selected design is not available in GOT Graphic Ver.1, the design is changed to an 
available design.

Custom
The settings available in GOT Graphic Ver.1 are migrated as-is.
The settings unavailable in GOT Graphic Ver.1 are discarded.

Item Specifications after the graphics mode change

When a solid color background is set
[Pattern] is set to [8].
The background color setting is migrated to [Background Color] and [Pattern Color].

When a gradient background is set

[Pattern] is set to [8].
The setting of [Color 1] is migrated to [Pattern Color].
The setting of [Color 2] is migrated to [Background Color].
The setting of [Variation] is deleted.

When a pattern background is set The setting is migrated to the [Basic] tab of the [Screen Property] dialog.

[Transparency] (for window screens only) The setting of this item is deleted.

[Screen Contour] (for window screens only) The setting of this item is deleted.

[Radius] (for window screens only) The setting of this item is deleted.

Item Specifications after the graphics mode change

[Expand base screen sizes]

The setting of this item is deleted.
The expanded base screens are resized to the size of the GOT screen.
For information on how the on-screen figures and objects are changed, refer to the following.

➟5.1.1 ■4 (3) How the expanded base screen data is converted (when disabling the base 
screen size expansion for the newly-selected GOT)

[Adjust object display order in GOT to the one in 
GT Designer3] This item is deselected.

Item Specifications after the graphics mode change

Parts Movement When [Circle] is selected for [Move Way], the selection is changed to [Line].
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12.15 Common Dialog

12.15.1 [Password Setting] dialog

1) [Level]
Displays the security level for the password.
Displayed when a password is edited in the [Screen Security] tab.

2) [Password]
Set a password.

3) [Re-enter Password]
Input the password set in [Password] for the confirmation.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)
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12.15.2 [Edit Password] dialog

1) [Level]
Displays the security level for the password.
Displayed when a password is edited in the [Screen Security] tab.

2) [Old Password]
Set the password currently set for the project.

3) [New Password]
Set a new password.

4) [Re-enter Password]
Input the password set in [New Password] for the confirmation.

12.15.3 [Delete Password] dialog

1) [Password]
Set the password currently set for the project.

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

3)

4)
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1)
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12.15.4 [Edit Comment] dialog

1) [Column No.]
Select the column No. of the comment to be edited.

2) [Comment]
Edit the comment in the comment group.
If an unregistered comment group No. or comment No. is displayed, create a new comment.
Up to 1024 characters can be set for the comment.
The number of characters, digits, and rows of the input comment are displayed on the upper right of the comment input 
field.

• Number of characters:
A character is counted as one character.
The line feed is counted as two characters.

• Number of digits:
The number of digits of the row with the largest number of digits is displayed.

• Number of rows:
The number of rows of the comment is displayed.
Even though a line feed is inserted without characters, the line feed is counted as one row.

12.15.5 [Detail Setting] dialog

1) [Driver]
Displays the driver that is currently set.

2) Detail Setting

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

GT27 SoftGOT2000GT25 GT23 GT21 GS25 GS21

1)

2)

When the driver is set to [Ethernet(MITSUBISHI ELECTRIC), Gateway]
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Setting items and setting ranges to be displayed vary depending on the driver to be used.

Item Description

[Transmission Speed(BPS)] Select the transmission speed.

[Data Bit] Select the data length.

[Stop Bit] Select the stop bit length.

[Parity] Select the type for a parity check.

[Sum Check] Select whether to perform a sum check.

[Sum Check Type] Select the type for a sum check.

[Retry(Times)]
Set the number of retries to be performed when a communication error occurs.

When no response is received after the retries, the communication times out.

[Startup Time(Sec)] Set the time period from the GOT startup to the beginning of the communication with the 
PLC CPU.

[Timeout Time(Sec)] Set the interval for communication to time out.

[Adapter Address] Set the adapter address in the connected network.

[Host] Set the host address in the connected network.

[Delay Time(ms)] Set the send delay time to lower the load of the network and the connected PLC CPUs.

[GOT Station] Set a station number of the host in the system configuration.

[Format] Select the communication format.

[Interrupt Data Byte] Select the number of bytes of the interrupt data.

[Station No. Selection] Select whether to use a station number at the communication or not.

[Special Interrupt Code] Select whether to have the special interrupt code output or not.

[Control method] Set this item when XON or XOFF control is used.

[Message Format] Select a message format.

[Communication data code] Select a communication data code.

[32bit Storage] Select an order for storing two words (32-bit data).

[Monitor Speed] Set the monitor speed of the GOT.

[Negotiation Time(Sec)] Set the time period that the GOT side communication setting is sent to the inverter.

[Initialization Wait Time(Sec)] Set the wait time from when the communication setting is changed until when the 
communication starts.

[Automatic Negotiation] Select whether to use the automatic negotiation.

[Function Code[0F]] Select whether to use the function code [0F] or not.

[Function Code[10]] Select whether to use the function code [10] or not.

[Read coil points] Set the maximum number of read coils.

[Read input relay points] Set the maximum number of read input relays.

[Read holding register points] Set the maximum number of read holding registers.

[Read input register points] Set the maximum number of read input registers.

[Write coil points] Set the maximum number of write multiple coils.

[Write holding register points] Set the maximum number of write multiple holding registers.

[Device read points(Points)] Set the number of consecutive devices from which data is read in one communication.

[Device write points(Points)] Set the number of consecutive devices to which data is written in one communication.

[Device read random points(Points)] Set the number of separate devices from which data is read in one communication.

[Device write random points(Points)] Set the number of separate devices to which data is written in one communication.

[Stage No.] Set the number of extension base units.

[Slot No.] Set the slot No.

[GOT Net No.] Set the network No. of the GOT.

[GOT Station] Set the GOT's station number.

[GOT Communication Port No.] Set the port No. used by the GOT for the connection with the Ethernet module.

[Protocol] Select a communication protocol.

[Interrupt Data Length] Set the number of bytes of the interrupt data.
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For the detail settings of peripheral devices including barcodes and RFIDs, refer to the following.

➟10.1.5 [Bar Code] dialog
➟10.2.5 [RFID] dialog
➟10.6.5 [Video/RGB Input] dialog
➟10.8.6 [Multimedia] dialog
➟10.11.8 [Printer] dialog

[Existence Confirmation] Select whether to perform an existence confirmation.

[Existence Confirmation Cycle(Sec)] Set the cycle to perform an existence confirmation.

[Network Type] Select a network type.

[Network No.] Set the network No.

[Station No.] Set the GOT's station number.

[Group No.] Group No.

[Mode] Set a mode.

[Transmission Speed(Mbps)] Select a transmission speed.

[Refresh Interval(Times)] Set how many times is the block data assurance per station (refresh) performed for the 
send data and the receive data.

[Transmission Speed(Gbps)] Select a transmission speed.

[Communication Speed] Select a communication speed.

[Refresh Interval(ms)] Set the interval for performing the block data assurance per station (refresh) for the send 
data and the receive data.

[Input for Error Station] Select whether to clear or hold the error at an error occurrence.

[Transmission Rate] Set the transmission speed and a mode of the GOT.

[Expanded Cyclic] Select the cyclic counts expansion.

[Occupied Station] Select the number of stations occupied by the GOT.

[Video Input Signal] Select the video input signal

[Video Resolution] Select the video resolution.

[IP Address] Set the IP address of the multimedia unit.

[Subnet Mask] Set the subnet mask.

[Default Gateway] Set the default gateway.

[Connection CH No.] Set the channel number used for the connection to the GOT (Extended computer).

[Transmission method] Set the CC-Link transmission method.

[CPU No. switching GD device first No. (3 
points)] Set the start device number of the GOT data registers (GD) to specify CPU numbers.

[Module No. switching GD device first No. (16 
points)] Set the start device number of the GOT data registers (GD) to specify module numbers.

[Servo axis switching GD device first No. (16 
points)] Set the start device number of the GOT data registers (GD) to specify an axis number.

[Output HOLD/CLEAR Setting] Select whether the GOT (remote station) holds the device values received from and sent 
to the master station when the master station stops running.

[Destination module I/O number] Specify a destination module I/O number to be returned from the GOT to the host station.

Item Description
12. APPENDICES
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12.16 Open Source Software

12.16.1 PDFium

PDFium, which is the BSD license, is used in this product.
The following describes the copyright notice and agreement notice of PDFium.
// Copyright 2014 PDFium Authors. All rights reserved.
//
// Redistribution and use in source and binary forms, with or without
// modification, are permitted provided that the following conditions are
// met:
//
//    * Redistributions of source code must retain the above copyright
// notice, this list of conditions and the following disclaimer.
//    * Redistributions in binary form must reproduce the above
// copyright notice, this list of conditions and the following disclaimer
// in the documentation and/or other materials provided with the
// distribution.
//    * Neither the name of Google Inc. nor the names of its
// contributors may be used to endorse or promote products derived from
// this software without specific prior written permission.
//
// THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
// "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
// LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
// A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
// OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
// SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
// LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
// DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
// THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
// (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
// OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
12 - 792 12. APPENDICES
12.16 Open Source Software



A
PP

EN
D

IC
ES

12
12.17 Upgraded Additional Function List

➟12.17.1 Supported hardware
12.17.2 Supported controller
12.17.3 Functions of GT Designer3
12.17.4 Drawing Setting
12.17.5 GOT functions

This section explains functions added by upgraded GT Designer (GOT2000).
The following shows the version of the system application that GT Designer 3 of each version supplies.

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual

1.100E 01.00.*** A - SH-081220ENG-A September 2013

1.104J 01.01.*** C - SH-081220ENG-B November 2013

1.108N 01.02.***
• GT27: D
• GT23: D
• GT21: B

D SH-081220ENG-C January 2014

1.109P 01.02.***
• GT27: D
• GT23: D
• GT21: B

D

SH-081220ENG-D April 2014

1.110Q 01.02.***
• GT27: D
• GT23: D
• GT21: B

D

1.111R 01.02.***

• GT27: D
• GT23: D
• GT21: C
• GS21: C

D

1.112S

• GT27: 01.03.***
• GT25: 01.03.***
• GT23: 01.03.***
• GT21: 01.02.***
• GS21: 01.02.***

• GT27: E
• GT25: E
• GT23: E
• GT21: C
• GS21: C

• GT27: E
• GT25: B
• GT23: D

1.117X

• GT27: 01.04.***
• GT25: 01.04.***
• GT23: 01.04.***
• GT21: 01.03.***
• GS21: 01.03.***

• GT27: F
• GT25: F
• GT23: F
• GT21: C
• GS21: C

• GT27: F
• GT25: F
• GT23: D

SH-081220ENG-E June 2014

1.118Y

• GT27: 01.05.***
• GT25: 01.05.***
• GT23: 01.05.***
• GT21: 01.04.***
• GS21: 01.04.***

• GT27: G
• GT25: G
• GT23: G
• GT21: C
• GS21: C

• GT27: F
• GT25: G
• GT23: D

SH-081220ENG-F July 2014

1.119Z 01.05.***

• GT27: G
• GT25: G
• GT23: H
• GT21: D
• GS21: C

• GT27: F
• GT25: G
• GT23: D

SH-081220ENG-G October 2014

1.122C 01.06.***

• GT27: J
• GT25: J
• GT23: J
• GT21: E
• GS21: C

H
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1.123D 01.07.***

• GT27: J
• GT25: J
• GT23: J
• GT21: E
• GS21: C

H

SH-081220ENG-H January 20151.124E

• GT27: 01.07.***
• GT25: 01.07.***
• GT23: 01.07.***
• GT21: 01.08.***
• GS21: 01.08.***

• GT27: K
• GT25: K
• GT23: K
• GT21: F
• GS21: C

H

1.126G

• GT27: 01.08.***
• GT25: 01.08.***
• GT23: 01.08.***
• GT21: 01.09.***
• GS21: 01.09.***

• GT27: L
• GT25: L
• GT23: L
• GT21: F
• GS21: C

J

1.127H 01.09.***

• GT27: L
• GT25: L
• GT23: L
• GT21: F
• GS21: C

J

SH-081220ENG-I April 20151.128J 01.09.***

• GT27: M
• GT25: L
• GT23: L
• GT21: F
• GS21: C

J

1.130L 01.10.***

• GT27: N
• GT25: N
• GT23: N
• GT21: G
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

1.131M 01.11.***

• GT27: P
• GT25: P
• GT23: N
• GT21: G
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

SH-081220ENG-J May 2015

1.134Q 01.12.***

• GT27: P
• GT25: Q
• GT23: N
• GT21: G
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

SH-081220ENG-K June 2015

1.136S 01.13.***

• GT27: R
• GT25: R
• GT23: R
• GT21: G
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

SH-081220ENG-L July 2015

1.137T

• GT27: 01.13.***
• GT25: 01.13.***
• GT23: 01.13.***
• GT21: 01.14.***
• GS21: 01.14.***

• GT27: S
• GT25: S
• GT23: S
• GT21: H
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

SH-081220ENG-M October 20151.138U

• GT27: 01.13.***
• GT25: 01.13.***
• GT23: 01.13.***
• GT21: 01.14.***
• GS21: 01.14.***

• GT27: S
• GT25: S
• GT23: S
• GT21: H
• GS21: C

• GT27: J
(GT2705-V: K)

• GT25: K
• GT23: J

1.144A

• GT27: 01.14.***
• GT25: 01.14.***
• GT23: 01.14.***
• GT21: 01.15.***
• GS21: 01.15.***

• GT27: T
• GT25: T
• GT23: T
• GT21: J
• GS21: C

• GT27: L
• GT25: L
• GT23: J

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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1.145B

• GT27: 01.14.***
• GT25: 01.14.***
• GT23: 01.14.***
• GT21: 01.15.***
• GS21: 01.15.***

• GT27: T
• GT25: T
• GT23: T
• GT21: J
• GS21: C

• GT27: L
• GT25: L
• GT23: J

SH-081220ENG-N December 2015

1.150G

• GT27: 01.15.***
• GT25: 01.15.***
• GT23: 01.15.***
• GT21: 01.16.***
• GS21: 01.16.***

• GT27: U
• GT25: U
• GT23: U
• GT21: J
• GS21: C

• GT27: M
• GT25: M
• GT23: J

1.151H

• GT27: 01.15.***
• GT25: 01.15.***
• GT23: 01.15.***
• GT21: 01.17.***
• GS21: 01.17.***

• GT27: U
• GT25: U
• GT23: U
• GT21: J
• GS21: C

• GT27: M
• GT25: M
• GT23: J

SH-081220ENG-O May 2016

1.152J

• GT27: 01.15.***
• GT25: 01.15.***
• GT23: 01.15.***
• GT21: 01.17.***
• GS21: 01.17.***

• GT27: V
• GT25: V
• GT23: V
• GT21: J
• GS21: C

• GT27: M
• GT25: M
• GT23: J

1.153K

• GT27: 01.15.***
• GT25: 01.15.***
• GT23: 01.15.***
• GT21: 01.17.***
• GS21: 01.17.***

• GT27: V
• GT25: V
• GT23: V
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

1.155M

• GT27: 01.16.***
• GT25: 01.16.***
• GT23: 01.16.***
• GT21: 01.18.***
• GS21: 01.18.***

• GT27: X
• GT25: X
• GT23: X
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

1.156N

• GT27: 01.16.***
• GT25: 01.16.***
• GT23: 01.16.***
• GT21: 01.18.***
• GS21: 01.18.***

• GT27: Y
• GT25: Y
• GT23: X
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

SH-081220ENG-P August 2016

1.160S

• GT27: 01.17.***
• GT25: 01.17.***
• GT23: 01.17.***
• GT21: 01.19.***
• GS21: 01.19.***

• GT27: Z
• GT25: Z
• GT23: Z
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

1.165X

• GT27: 01.18.***
• GT25: 01.18.***
• GT23: 01.18.***
• GT21: 01.20.***
• GS21: 01.20.***

• GT27: AA
• GT25: AA
• GT23: AA
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

SH-081220ENG-Q October 2016

1.166Y

• GT27: 01.18.***
• GT25: 01.18.***
• GT23: 01.18.***
• GT21: 01.20.***
• GS21: 01.20.***

• GT27: AA
• GT25: AA
• GT23: AA
• GT21: J
• GS21: C

• GT27: N
• GT25: N
• GT23: N

SH-081220ENG-R January 2017

1.170C

• GT27: 01.19.***
• GT25: 01.19.***
• GT23: 01.19.***
• GT21: 01.21.***
• GS21: 01.21.***

• GT27: AB
• GT25: AB
• GT23: AB
• GT21: K
• GS21: C

• GT27: P
• GT25: P
• GT23: N

1.175H

• GT27: 01.20.***
• GT25: 01.20.***
• GT23: 01.20.***
• GT21: 01.22.***
• GS21: 01.22.***

• GT27: AC
• GT25: AC
• GT23: AC
• GT21: K
• GS21: C

• GT27: P
• GT25-W: Q
• GT25-S, GT25-V: P
• GT23: N

SH-081220ENG-S April 2017

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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1.178L

• GT27: 01.21.***
• GT25: 01.21.***
• GT23: 01.21.***
• GT21: 01.23.***
• GS21: 01.23.***

• GT27: AC
• GT25: AC
• GT23: AC
• GT21: K
• GS21: C

• GT27: P
• GT25-W: Q
• GT25-S, GT25-V: P
• GT23: N

SH-081220ENG-T June 2017

1.180N

• GT27: 01.22.***
• GT25: 01.22.***
• GT23: 01.22.***
• GT21: 01.24.***
• GS21: 01.24.***

• GT27: AD
• GT25: AD
• GT23: AC
• GT21: K
• GS21: C

• GT27: P
(GT2705-V: R)

• GT25-W: Q
• GT25-S, GT25-V: R
• GT23: N

1.181P

• GT27: 01.22.***
• GT25: 01.22.***
• GT23: 01.22.***
• GT21: 01.24.***
• GS21: 01.24.***

• GT27: AD
• GT25: AD
• GT23: AD
• GT21: K
• GS21: C

• GT27: P
(GT2705-V: R)

• GT25-W: Q
• GT25-S, GT25-V: R
• GT23: N

SH-081220ENG-U October 2017

1.185T

• GT27: 01.23.***
• GT25: 01.23.***
• GT23: 01.23.***
• GT21: 01.25.***
• GS21: 01.25.***

• GT27: AE
• GT25: AE
• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S, GT25-V: R
• GT23: N

1.190Y

• GT27: 01.24.***
• GT25: 01.24.***
• GT23: 01.24.***
• GT21: 01.26.***
• GS21: 01.26.***

• GT27: AE
• GT25: AE
• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S, GT25-V: R
• GT23: N

SH-081220ENG-V December 2017

1.195D

• GT27: 01.25.***
• GT25: 01.25.***
• GT23: 01.25.***
• GT21: 01.27.***
• GS21: 01.27.***

• GT27: AF
• GT25: AF
• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: T)
• GT2506HS-V: R
• GT2505HS-V: T
• GT23: N

SH-081220ENG-W April 2018

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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1.196E

• GT27: 01.25.***
• GT25: 01.25.***
• GT23: 01.25.***
• GT21: 01.27.***
• GS21: 01.27.***

• GT27: AG
(GT2705-V: AF)

• GT25: AF
(GT2505-V: AG)

• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

SH-081220ENG-X July 2018

1.197F

• GT27: 01.25.***
• GT25: 01.25.***
• GT23: 01.25.***
• GT21: 01.27.***
• GS21: 01.27.***

• GT27: AG
(GT2705-V: AF)

• GT25: AF
(GT2505-V: AH)

• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

1.198G

• GT27: 01.25.***
• GT25: 01.25.***
• GT23: 01.25.***
• GT21: 01.27.***
• GS21: 01.27.***

• GT27: AG
(GT2705-V: AF)

• GT25: AF
(GT2505-V: AH)

• GT23: AE
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

1.200J

• GT27: 01.26.***
• GT25: 01.26.***
• GT23: 01.26.***
• GT21: 01.28.***
• GS21: 01.28.***

• GT27: AJ
• GT25: AJ
• GT23: AJ
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

1.205P

• GT27: 01.27.***
• GT25: 01.27.***
• GT23: 01.27.***
• GT21: 01.29.***
• GS21: 01.29.***

• GT27: AK
• GT25: AK
• GT23: AK
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

SH-081220ENG-Y October 2018

1.206Q

• GT27: 01.27.***
• GT25: 01.27.***
• GT23: 01.27.***
• GT21: 01.29.***
• GS21: 01.29.***

• GT27: AK
• GT25: AK
• GT23: AK
• GT21: K
• GS21: C

• GT27: S
(GT2705-V: R)

• GT25-W: Q
• GT25-S: R
• GT25-V: R

(GT2505-V: U)
• GT2506HS-V: R
• GT2505HS-V: U
• GT23: N

SH-081220ENG-Z January 2019

1.210U

• GT27: 01.28.***
• GT25: 01.28.***
• GT23: 01.28.***
• GT21: 01.30.***
• GS21: 01.30.***

• GT27: AL
• GT25: AL
• GT23: AL
• GT21: K
• GS21: C

• GT27: V
• GT25: V
• GT23: N

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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1.211V

• GT27: 01.28.***
• GT25: 01.28.***
• GT23: 01.28.***
• GT21: 01.30.***
• GS21: 01.30.***

• GT27: AL
• GT25: AL
• GT23: AL
• GT21: K
• GS21: C

• GT27: V
• GT25: V
• GT23: N

SH-081220ENG-AA April 2019

1.215Z

• GT27: 01.29.***
• GT25: 01.29.***
• GT23: 01.29.***
• GT21: 01.31.***
• GS21: 01.31.***

• GT27: AM
• GT25: AM

(GT2505-V: AL)
• GT23: AL
• GT21: L
• GS21: C

• GT27: V
• GT25: V
• GT23: N

1.217B

• GT27: 01.30.***
• GT25: 01.30.***
• GT23: 01.30.***
• GT21: 01.32.***
• GS21: 01.32.***

• GT27: AN
• GT25: AN

(GT2505-V: AL)
• GT23: AL
• GT21: L
• GS21: C

• GT27: V
• GT25: V
• GT23: N

SH-081220ENG-AB July 2019

1.220E

• GT27: 01.31.***
• GT25: 01.31.***
• GT23: 01.31.***
• GT21: 01.33.***
• GS21: 01.33.***

• GT27: AP
• GT25: AP
• GT23: AP
• GT21: L
• GS21: C

W

1.225K

• GT27: 01.32.***
• GT25: 01.32.***
• GT23: 01.32.***
• GT21: 01.34.***
• GS21: 01.34.***

• GT27: AQ
• GT25: AQ
• GT23: AQ
• GT21: L
• GS21: C

• GT27: W
• GT25: W

(GT2505-V: X)
• GT23: W

SH-081220ENG-AC October 2019

1.230Q

• GT27: 01.33.***
• GT25: 01.33.***
• GT23: 01.33.***
• GT21: 01.35.***
• GS21: 01.35.***

• GT27: AR
• GT25: AR
• GT23: AR
• GT21: L
• GS21: C

• GT27: W
• GT25: W

(GT2505-V: X)
• GT23: W

SH-081220ENG-AD January 2020

1.231R

• GT27: 01.33.***
• GT25: 01.33.***
• GT23: 01.33.***
• GT21: 01.35.***
• GS21: 01.35.***

• GT27: AR
• GT25: AR
• GT23: AR
• GT21: L
• GS21: C

• GT27: W
• GT25: W

(GT2505-V: X)
• GT23: W

SH-081220ENG-AE April 2020

1.235V

• GT27: 01.34.***
• GT25: 01.34.***
• GT23: 01.34.***
• GT21: 01.36.***
• GS21: 01.36.***

• GT27: AS
• GT25: AS
• GT23: AS
• GT21: M
• GS21: C

Y

1.236W

• GT27: 01.35.***
• GT25: 01.35.***
• GT23: 01.35.***
• GT21: 01.36.***
• GS21: 01.36.***

• GT27: AS
• GT25: AS
• GT23: AS
• GT21: M
• GS21: C

Y SH-081220ENG-AF May 2020

1.240A

• GT27: 01.36.***
• GT25: 01.36.***
• GT23: 01.36.***
• GT21: 01.37.***
• GS21: 01.37.***

• GT27: AT
• GT25: AT
• GT23: AT
• GT21: M
• GS21: C

Z SH-081220ENG-AG June 2020

1.241B

• GT27: 01.36.***
• GT25: 01.36.***
• GT23: 01.36.***
• GT21: 01.37.***
• GS21: 01.37.***

• GT27: AT
• GT25: AT
• GT23: AT
• GT21: N
• GS21: C

Z

SH-081220ENG-AH October 2020

1.245F

• GT27: 01.37.***
• GT25: 01.37.***
• GT23: 01.37.***
• GT21: 01.38.***
• GS21: 01.38.***

• GT27: AU
• GT25: AU
• GT23: AU
• GT21: N
• GS21: C

AA

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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1.250L

• GT27: 01.38.***
• GT25: 01.38.***
• GT23: 01.38.***
• GT21: 01.39.***
• GS21: 01.39.***

• GT27: AU
• GT25: AU

(GT25-W: AV)
• GT23: AU
• GT21: P
• GS21: P

(GS21-W: C)

AA SH-081220ENG-AI January 2021

1.255R

• GT27: 01.39.***
• GT25: 01.39.***
• GT23: 01.39.***
• GT21: 01.40.***
• GS21: 01.40.***

• GT27: AW
• GT25: AW
• GT23: AW
• GT21: P
• GS21: P

(GS21-W: C)

• GT27: AB
• GT25: AB
• GT23: AA

SH-081220ENG-AJ April 2021

1.260W

• GT27: 01.40.***
• GT25: 01.40.***
• GT23: 01.40.***
• GT21: 01.41.***
• GS21: 01.41.***

• GT27: AW
• GT25: AW
• GT23: AW
• GT21: Q
• GS21: Q

(GS21-W: C)

• GT27: AB
• GT25: AB
• GT23: AA

SH-081220ENG-AK July 2021

1.265B 01.42.***

• GT27: AW
• GT25: AW
• GT23: AW
• GT21: Q
• GS21: Q

(GS21-W: C)

• GT27: AB
• GT25: AB
• GT23: AA

SH-081220ENG-AL October 2021

1.267D 01.42.***

• GT27: AW
• GT25: AW
• GT23: AW
• GT21: Q
• GS21: Q

(GS21-W: C)

• GT27: AB
• GT25: AB
• GT23: AA

SH-081220ENG-AM January 2022

1.270G 01.43.***

• GT27: AX
• GT25: AX
• GT23: AX
• GT21: Q
• GS21: Q

(GS21-W: C)

AC

1.271H

• GT27: 01.43.***
(GT2705-V: 01.44.***)

• GT25: 01.43.***
• GT23: 01.43.***
• GT21: 01.44.***
• GS21: 01.44.***

(GS21-W: 01.44.***)

• GT27: AX
(GT2705-V: AY)

• GT25: AX
• GT23: AX
• GT21: Q
• GS21: Q

(GS21-W: C)

AC SH-081220ENG-AN April 2022

1.275M 01.45.***

1.280S 01.46.***

• GT27: AX
(GT2705-V: AY)

• GT25: AX
• GT23: AX
• GT21: Q
• GS21: Q

(GS21-W: C)

AC SH-081220ENG-AP July 2022

1.285X 01.47.***

• GT27: AX
(GT2705-V: AY)

• GT25: AX
• GT23: AX
• GT21: Q
• GS21: Q

(GS21-W: C)

AC SH-081220ENG-AQ October 2022

1.290C 01.48.***

• GT27: AZ
• GT25: AZ
• GT23: AZ
• GT21: Q
• GS21: Q

(GS21-W: C)

AC SH-081220ENG-AR January 2023

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
12. APPENDICES
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1.295H 01.49.***

• GT27: AZ
• GT25: AZ
• GT23: AZ
• GT21: Q
• GS25: AZ
• GS21: Q

(GS21-W: C)

AD SH-081220ENG-AS April 2023

GT Designer3 version System application 
version BootOS version CoreOS version Version and revision date of this manual
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12.17.1 Supported hardware

Product name Model Applicable GT Designer3 
version

GT27

GT2715-XTBA, GT2715-XTBD 1.112S

GT2712-STBA, GT2712-STBD, GT2712-STWA, GT2712-
STWD 1.100E

GT2710-STBA, GT2710-STBD, GT2710-VTBA, GT2710-
VTBD, GT2710-VTWA, GT2710-VTWD 1.100E

GT2708-STBA, GT2708-STBD, GT2708-VTBA, GT2708-
VTBD 1.100E

GT2705-VTBD 1.130L

GT25

GT2512-STBA, GT2512-STBD 1.122C

GT2512F-STNA, GT2512F-STND 1.150G

GT2512-WXTBD, GT2512-WXTSD 1.250L

GT2510-WXTBD, GT2510-WXTSD 1.175H

GT2510-VTBA, GT2510-VTBD, GT2510-VTWA, GT2510-
VTWD 1.112S

GT2510F-VTNA, GT2510F-VTND 1.150G

GT2508-VTBA, GT2508-VTBD, GT2508-VTWA, GT2508-
VTWD 1.112S

GT2508F-VTNA, GT2508F-VTND 1.150G

GT2507-WTBD, GT2507-WTSD 1.175H

GT2507T-WTSD 1.195D

GT2505-VTBD 1.180N

GT2506HS-VTBD 1.170C

GT2505HS-VTBD 1.195D

GT23
GT2310-VNBA, GT2310-VNBD 1.100E

GT2308-VNBA, GT2308-VNBD 1.100E

GT21

GT2107-WTBD, GT2107-WTSD 1.170C

GT2105-QTBDS, GT2105-QMBDS 1.144A

GT2104-RTBD 1.122C

GT2104-PMBD, GT2104-PMBDS 1.131M

GT2104-PMBDS2, GT2104-PMBLS 1.137T

GT2103-PMBD, GT2103-PMBDS 1.112S

GT2103-PMBDS2, GT2103-PMBLS 1.119Z

GS25 GS2512-WXTBD 1.295H

GS21
GS2110-WTBD-N, GS2107-WTBD-N 1.250L

GS2110-WTBD, GS2107-WTBD 1.105K

GT SoftGOT2000 GT SoftGOT2000 1.100E

Bus connection unit GT15-QBUS, GT15-QBUS2, GT15-75QBUSL, GT15-
75QBUS2L 1.100E

Serial communication unit GT15-RS2-9P, GT15-RS4-9S, GT15-RS4-TE 1.100E

MELSECNET/H communication unit GT15-J71LP23-25, GT15-J71BR13 1.100E

CC-Link IE TSN communication unit GT25-J71GN13-T2
1.217B
BootOS: AN

CC-Link IE Controller Network communication unit GT15-J71GP23-SX 1.100E

CC-Link IE Field Network communication unit GT15-J71GF13-T2 1.100E

CC-Link communication unit GT16-J61BT13 1.100E

Wireless LAN communication unit GT25-WLAN
1.108N
BootOS: D
12. APPENDICES
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Serial multi-drop connection unit GT01-RS4-M 1.100E

Field network adapter unit GT25-FNADP
1.130L
BootOS: N

Ethernet communication unit GT25-J71E71-100
1.160S
BootOS: Z

Connection conversion adapter GT10-9PT5S 1.180N

RS-232/485 signal conversion adapter GT14-9RS2T4-9P 1.180N

Printer unit GT15-PRN 1.104J

Video/RGB input unit GT27-V4R1-Z 1.100E

Video input unit GT27-V4-Z 1.100E

RGB input unit
GT27-R2

1.130L
BootOS: N

GT27-R2-Z 1.100E

RGB output unit
GT27-ROUT

1.130L
BootOS: N

GT27-ROUT-Z 1.100E

Multimedia unit GT27-MMR-Z 1.100E

Digital video output unit GT27-VHOUT
1.205P
BootOS: AK

Sound output unit GT15-SOUT 1.100E

External I/O unit GT15-DIO, GT15-DIOR 1.100E

SD card unit GT21-03SDCD 1.112S

Connector conversion box
GT16H-CNB-42S 1.170C

GT16H-CNB-37S, GT11H-CNB-37S 1.195D

Product name Model Applicable GT Designer3 
version
12 - 802 12. APPENDICES
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12.17.2 Supported controller

For the controller supported by each communication driver, refer to the following.
➟12.2 Correspondence between the setting of [Controller Type] and the controller used

■1 Mitsubishi equipment
➟(1) Serial(MELSEC)(formerly Q/L/QnA/A CPU, QJ71C24, LJ71C24)

(2) Serial(MELSEC)(formerly MELSEC-Q/L/QnA)
(3) AJ71QC24, MELDAS C6*
(4) AJ71C24/UC24
(5) MELSEC-FX
(6) MELSEC-WS
(7) CC-Link(G4)
(8) MELSERVO-J4,J3,J2S/M,JE(formerly MELSERVO-J4,J3,J2S/M)
(9) Multidrop (Slave)
(10) FREQROL 500/700/800,SENSORLESS SERVO
(11) FREQROL 800
(12) FREQROL(Batch monitor)
(13) Laser Displacement Sensor MH11
(14) Ethernet(MITSUBISHI ELECTRIC), Gateway (formerly Ethernet (MELSEC), Q17nNC, CRnD-700, 
Gateway)
(15) Ethernet(FX),Gateway
(16) Ethernet(MELSERVO), Gateway
(17) Ethernet(FREQROL), Gateway
(18) Ethernet(FREQROL(Batch monitor)), Gateway
(19) Bus A/QnA
(20) Bus Q
(21) MELSECNET/H
(22) CC-Link IE TSN
(23) CC-Link IE Controller Network
(24) CC-Link IE Field Network
(25) CC-Link Ver.2(ID)

For the controllers compatible with GT SoftGOT2000, refer to the following.
➟GT SoftGOT2000 Version1 Operating Manual
12. APPENDICES
12.17 Upgraded Additional Function List

12 - 803



(1) Serial(MELSEC)(formerly Q/L/QnA/A CPU, QJ71C24, LJ71C24)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.04.***

• The driver name has been changed.
(Unified with MELSEC-Q/L/QnA.)

• The connection to RCPU is supported.
• The global label is supported.

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

• The connection to MELSEC iQ-F is supported.
• The connection to the Motion CPU (MELSEC iQ-R series) is supported.

01.10.***
• The connection to RnPCPU is supported.
• The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.12.*** The connection to RnENCPU is supported.

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

• The connection to RnSFCPU is supported.
• The connection to R64MTCPU is supported.
• The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 

module is supported.

GT27, GT25, GT23: 01.15.***
GT21, GS21: 01.16.***

The connection to Q26DHCCPU-LS is supported.

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

The connection to CNC C80 is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The redundant system using RCPU is supported.

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

GT27, GT25, GT23: 01.20.***
GT21, GS21: 01.22.***

The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

GT27, GT25, GT23: 01.21.***
GT21, GS21: 01.23.***

The connection to CR800-R is supported.

GT27, GT25, GT23: 01.24.***
GT21, GS21: 01.26.***

The connection to R00CPU, R01CPU, or R02CPU is supported.

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 
CPU is supported.

GT27, GT25, GT23: 01.26.***
GT21, GS21: 01.28.***

• The connection to SIL2 Process CPU is supported.
• The connection to FR-E700-NE through a PLC CPU is supported.
• Automatically switching the monitoring target while the GOT is monitoring the equipment on a 

different network through the Redundant CPU on a relay station is supported.

GT27, GT25, GT23: 01.27.***
GT21, GS21: 01.29.***

The connection to CR800-Q is supported.

GT27, GT25, GT23: 01.31.***
GT21, GS21: 01.33.***

The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

GT27, GT25, GT23: 01.32.***
GT21, GS21: 01.34.***

The connection to FX5UJ is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.

GT27, GT25, GT23: 01.37.***
GT21, GS21: 01.38.***

Monitoring BL or BLS when connecting with FX5U or FX5UC is supported.

01.43.***
• The connection to R102WCPU-W is supported.
• The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 

Motion module (QD77MS) is supported.

01.45.*** The connection to FX5S is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(2) Serial(MELSEC)(formerly MELSEC-Q/L/QnA)

(3) AJ71QC24, MELDAS C6*

(4) AJ71C24/UC24

(5) MELSEC-FX

Version of communication 
driver Added and edited function Supported 

models

01.02.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.04.***
The driver name has been changed.
(Unified with Q/L/QnA/A CPU, QJ71C24, LJ71C24)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.02.*** The connection to FX3GE is supported.

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(6) MELSEC-WS

(7) CC-Link(G4)

(8) MELSERVO-J4,J3,J2S/M,JE(formerly MELSERVO-J4,J3,J2S/M)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.05.***
GT21, GS21: 01.04.***

The connection to WS0-CPU3 is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 
module is supported.

GT27, GT25, GT23: 01.15.***
GT21, GS21: 01.16.***

The connection to Q26DHCCPU-LS is supported.

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

GT27, GT25, GT23: 01.20.***
GT21, GS21: 01.22.***

The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.43.*** The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 
Motion module (QD77MS) is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.02.*** The connection to the MELSERVO-JE series is supported.

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

01.06.*** The connection to MR-J4-*A-RJ is supported.

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

The connection to MR-J4-*A-RJ using the indexer positioning operation is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(9) Multidrop (Slave)

(10)FREQROL 500/700/800,SENSORLESS SERVO

(11)FREQROL 800

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Models other than GT21: 
01.15.***
GT21: 01.16.***

The connection to Q26DHCCPU-LS is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.02.*** The connection to the FR-800 series or the sensorless servo is supported.

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

The connection to FR-B (A700 specification) or FR-B3 (A700 specification) is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection to FR-A800 Plus, FR-B (A800 specification), or FR-B3 (A800 specification) is 
supported.

GT27, GT25, GT23: 01.18.***
GT21, GS21: 01.20.***

The connection to FR-F800-E is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN or FR-E800 is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) is supported.

Version of communication 
driver Added and edited function Supported 

models

01.02.*** The connection to the FR-800 series (Automatic connection and the use of the PLC function) is 
supported.

01.03.*** -

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(12)FREQROL(Batch monitor)

(13)Laser Displacement Sensor MH11

(14)Ethernet(MITSUBISHI ELECTRIC), Gateway (formerly Ethernet (MELSEC), Q17nNC, CRnD-700, 
Gateway)

01.10.*** The connection to the FR-800 series (Automatic connection and the use of the PLC function) is 
supported.

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

The connection to FR-A800-E is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection to FR-A800 Plus, FR-B (A800 specification), or FR-B3 (A800 specification) is 
supported.

GT27, GT25, GT23: 01.18.***
GT21, GS21: 01.20.***

The connection to FR-F800-E is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN or FR-E800 is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.27.***
GT21, GS21: 01.29.***

- (first edition)

GT27, GT25, GT23: 01.31.***
GT21, GS21: 01.33.***

The connection to FR-A800 Plus (CRN and R2R) is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN or FR-E800 is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) is supported.

Version of communication 
driver Added and edited function Supported 

models

01.20.***
The connection to MH11CTMF-N, MH11CTMF-NNA, MH11CTMF-P, and MH11CTMF-PNA is 
supported.
(Only available to GT2104-PMBDS2)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

The connection to Q24DHCCPU-VG is supported.

GT27, GT25, GT23: 01.04.***
GT21, GS21: 01.03.***

• The connection to RCPU is supported.
• The global label is supported.

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

• The connection to MELSEC iQ-F is supported.
• The connection to the Motion CPU (MELSEC iQ-R series) is supported.

01.10.***
• The connection to RnPCPU is supported.
• The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.12.*** The connection to RnENCPU is supported.

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

• The connection to RnSFCPU is supported.
• The connection to R64MTCPU is supported.
• The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 

module is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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GT27, GT25, GT23: 01.15.***
GT21, GS21: 01.16.***

The connection to Q26DHCCPU-LS is supported.

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

The connection to CNC C80 is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

• The redundant system using RCPU is supported.
• The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

GT27, GT25, GT23: 01.20.***
GT21, GS21: 01.22.***

The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

GT27, GT25, GT23: 01.20.***
GT21, GS21: 01.22.***

• The connection to CR800-D is supported.
• The connection to CR800-R is supported.

GT27, GT25, GT23: 01.22.***
GT21, GS21: 01.24.***

• The driver name has been changed.

GT27, GT25, GT23: 01.24.***
GT21, GS21: 01.26.***

The connection to R00CPU, R01CPU, or R02CPU is supported.

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

• The connection to MELIPC is supported.
• The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 

CPU is supported.

GT27, GT25, GT23: 01.26.***
GT21, GS21: 01.28.***

• The connection to SIL2 Process CPU is supported.
• The connection to FR-E700-NE through a PLC CPU is supported.
• Automatically switching the monitoring target while the GOT is monitoring the equipment on a 

different network through the Redundant CPU on a relay station is supported.

GT27, GT25, GT23: 01.27.***
GT21, GS21: 01.29.***

The connection to CR800-Q is supported.

GT27, GT25, GT23: 01.31.***
GT21, GS21: 01.33.***

• The connection to the master station on a CC-Link IE TSN network is supported.
• The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

GT27, GT25, GT23: 01.32.***
GT21, GS21: 01.34.***

The connection to FX5UJ is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

• The connection to LHCPU is supported.
• The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

GT27, GT25, GT23: 01.34.***
GT21, GS21: 01.36.***

The connection to Motion module is supported.
(GT27, GT25, GT23)

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

• The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.
• The connection to MR-J5-G(-RJ), MR-J5W2-G, or MR-J5W3-G through a Motion module is 

supported.

GT27, GT25, GT23: 01.37.***
GT21, GS21: 01.38.***

• Monitoring BL or BLS when connecting with FX5U or FX5UC is supported.
• The connection to MR-JET-G through a Motion module is supported.

GT27, GT25, GT23: 01.40.***
GT21, GS21: 01.41.***

• The connection to the Motion module (RD78G□) through the C Controller module (MELSEC iQ-
R series) is supported.

• The connection to the RnPCPU and C Controller module (MELSEC iQ-R series) using the CC-
Link IE TSN master/local module (RJ71GN11-T2) or the Motion module (RD78G□) is supported.

01.42.***
• The connection to FX5U or FX5UC through a Motion module (FX5-□SSC-G) is supported.
• The connection to MR-J5-G(-RJ), MR-J5W2-G, MR-J5W3-G or MR-JET-G through a Motion 

module (FX5-□SSC-G) is supported.

01.43.***

• The connection to R102WCPU-W is supported.
• The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 

Motion module (QD77MS) is supported.
• The connection to MR-J5D-G through a Motion module (FX5-□SSC-G or RD78G□) is supported.

01.45.***
• The connection to MR-J5-G(-RJ), MR-J5W2-G, MR-J5W3-G, or MR-JET-G through the CC-Link 

IE TSN master/local module (RJ71GN11-T2) is supported.
• The connection to FX5S is supported..

01.46.*** The connection to RnCPU or RnENCPU through the CC-Link IE TSN Plus master/local module 
(RJ71GN11-EIP) is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(15)Ethernet(FX),Gateway

(16)Ethernet(MELSERVO), Gateway

(17)Ethernet(FREQROL), Gateway

(18)Ethernet(FREQROL(Batch monitor)), Gateway

(19)Bus A/QnA

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.23.***
GT21, GS21: 01.25.***

- (first edition)

GT27, GT25, GT23: 01.40.***
GT21, GS21: 01.41.***

The connection to MR-J5-□G(-RJ), MR-J5W-□G, and MR-JET-□G is supported

01.43.*** The connection to MR-J5D-G is supported.

01.47.*** The connection to MR-J5-B through a Motion controller (RnMTCPU) or a Motion module 
(RD77MS) is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

- (first edition)

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.31.***
GT21, GS21: 01.33.***

The connection to FR-A800 Plus (CRN and R2R) is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN or FR-E800-E is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

- (first edition)

GT27, GT25, GT23: 01.26.***
GT21, GS21: 01.28.***

The connection to FR-E700-NE is supported.

GT27, GT25, GT23: 01.31.***
GT21, GS21: 01.33.***

The connection to FR-A800 Plus (CRN and R2R) is supported.

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

The connection to FR-A800-GN or FR-E800-E is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FR-A800 Plus (AWH and LC) is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(20)Bus Q

(21)MELSECNET/H

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.14.*** The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 
module is supported.

01.15.*** The connection to Q26DHCCPU-LS is supported.

01.19.*** The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

01.20.*** The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.25.*** The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 
CPU is supported.

01.26.*** The connection to FR-E700-NE is supported.

01.27.*** The connection to CR800-Q is supported.

01.31.*** The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

01.33.*** The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

01.36.*** The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.

01.43.*** The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 
Motion module (QD77MS) is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.14.*** The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 
module is supported.

01.15.*** The connection to Q26DHCCPU-LS is supported.

01.19.*** The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

01.20.*** The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.25.*** The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 
CPU is supported.

01.26.*** Automatically switching the monitoring target while the GOT is monitoring the equipment on a 
different network through the Redundant CPU on a relay station is supported.

01.27.*** The connection to CR800-Q is supported.

01.31.*** The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

01.33.*** The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

01.36.*** The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.

01.43.*** The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 
Motion module (QD77MS) is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(22)CC-Link IE TSN

Version of communication 
driver Added and edited function Supported 

models

01.30.*** - (first edition)

01.32.***
• Transient transmission is supported.
• The connection to MR-J4-B(-RJ) is supported.

01.33.***
• The connection to FR-A800, FR-A800-GN, FR-F800, or FR-E800-E is supported.
• The connection to a Mitsubishi Electric inverter through a PLC CPU is supported.

01.36.*** The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.

01.37.***
• Monitoring BL or BLS when connecting with FX5U or FX5UC is supported.
• Ring connection is supported.
• The connection to R08SFCPU, R16SFCPU, R32SFCPU, or R120SFCPU is supported.

01.40.*** The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.43.*** The connection to R102WCPU-W is supported.

01.46.***

• The connection to RnCPU, RnENCPU, or RnSFCPU through the CC-Link IE TSN Motion module 
(RD78G(H)) is supported.

• The connection to RnCPU or RnENCPU through the CC-Link IE TSN Plus master/local module 
(RJ71GN11-EIP) is supported.

01.47.*** The connection to MR-J5(W)-□B(-RJ) through a Motion controller or a Simple Motion module is 
supported.

01.49.***

• The connection to FR-A800 Plus (GF and E-R2R) through the CC-Link IE TSN Motion module 
(RD78G(H)) is supported.

• The connection to FR-A800 Plus (GF and E-R2R) through the CC-Link IE TSN Plus master/local 
module (RJ71GN11-EIP) is supported.

• The connection to MR-JET-G through the CC-Link IE TSN Plus master/local module (RJ71GN11-
EIP) is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(23)CC-Link IE Controller Network

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.04.*** The connection to RCPU is supported.

01.10.***
• The connection to RnPCPU is supported.
• The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.12.*** The connection to RnENCPU is supported.

01.14.***

• The connection to RnSFCPU is supported.
• The connection to R64MTCPU is supported.
• The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 

module is supported.

01.15.*** The connection to Q26DHCCPU-LS is supported.

01.16.*** The connection to CNC C80 is supported.

01.17.*** The redundant system using RCPU is supported.

01.19.*** The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

01.20.*** The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.21.*** The connection to CR800-R is supported.

01.25.*** The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 
CPU is supported.

01.26.***

• The connection to SIL2 Process CPU is supported.
• The connection to FR-E700-NE through a PLC CPU is supported.
• Automatically switching the monitoring target while the GOT is monitoring the equipment on a 

different network through the Redundant CPU on a relay station is supported.

01.27.*** The connection to CR800-Q is supported.

01.31.*** The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

01.33.*** The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

01.36.*** The connection to FR-A800 Plus (AWH and LC) through a PLC CPU is supported.

01.43.***
• The connection to R102WCPU-W is supported.
• The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 

Motion module (QD77MS) is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(24)CC-Link IE Field Network

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.04.*** The connection to RCPU is supported.

01.10.***
• The connection to RnPCPU is supported.
• The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.12.*** The connection to RnENCPU is supported.

01.14.***

• The connection to RnSFCPU is supported.
• The connection to R64MTCPU is supported.
• The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 

module is supported.

01.15.*** The connection to Q26DHCCPU-LS is supported.

01.16.*** The connection to CNC C80 is supported.

01.17.***
• The connection to MELSEC iQ-F series is supported.
• The redundant system using RCPU is supported.

01.19.*** The connection to MR-J4-GF(-RJ) through a motion controller or a simple motion module is 
supported.

01.20.*** The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.21.*** The connection to CR800-R is supported.

01.25.***
• The connection to MELIPC is supported.
• The connection to FR-A800, FR-A800-E, FR-F800, FR-F800-E, or FR-A800-GF through a PLC 

CPU is supported.

01.26.***

• The connection to SIL2 Process CPU is supported.
• The connection to FR-E700-NE through a PLC CPU is supported.
• Automatically switching the monitoring target while the GOT is monitoring the equipment on a 

different network through the Redundant CPU on a relay station is supported.

01.27.*** The connection to CR800-Q is supported.

01.31.*** The connection to FR-A800 Plus (CRN and R2R) through a PLC CPU is supported.

01.32.*** The connection to FX5UJ is supported.

01.33.*** The connection to FR-A800-GN, FR-E800, or FR-E800-E through a PLC CPU is supported.

01.36.*** The connection to FR-A800-LC through a PLC CPU is supported.

01.37.*** Monitoring BL or BLS when connecting with FX5U or FX5UC is supported.

01.43.*** The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 
Motion module (QD77MS) is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(25)CC-Link Ver.2(ID)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** The connection to Q24DHCCPU-VG is supported.

01.04.*** The connection to RCPU is supported.

01.10.***
• The connection to RnPCPU is supported.
• The connection to the C Controller module (MELSEC iQ-R series) is supported.

01.12.*** The connection to RnENCPU is supported.

01.14.***

• The connection to RnSFCPU is supported.
• The connection to R64MTCPU is supported.
• The connection to MR-J4(W)-*B(-RJ) or MR-JE-*B through a motion controller or a simple motion 

module is supported.

01.15.*** The connection to Q26DHCCPU-LS is supported.

01.16.*** The connection to CNC C80 is supported.

01.17.*** The redundant system using RCPU is supported.

01.20.*** The connection to MR-JE-*BF through a motion controller or a simple motion module is supported.

01.21.*** The connection to CR800-R is supported.

01.26.***

• The connection to SIL2 Process CPU is supported.
• The connection to FR-E700-NE through a PLC CPU is supported.
• Automatically switching the monitoring target while the GOT is monitoring the equipment on a 

different network through the Redundant CPU on a relay station is supported.

01.27.*** The connection to CR800-Q is supported.

01.32.*** The connection to FX5UJ is supported.

01.43.***
• The connection to R102WCPU-W is supported.
• The connection to MR-J5(W)-□B(-RJ) through a Motion controller (Q17nDSCPU) or a Simple 

Motion module (QD77MS) is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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■2 Non-Mitsubishi products
➟(1) IAI X-SEL

(2) IAI robocylinder
(3) AZBIL SDC/DMC
(4) AZBIL DMC50
(5) OMRON SYSMAC
(6) Ethernet(OMRON),Gateway
(7) Ethernet(OMRON NJ/NX), Gateway
(8) OMRON THERMAC/INPANEL NEO
(9) OMRON Digital Temperature Controller
(10) Serial(KEYENCE)(formerly KEYENCE KV-700/1000)
(11) Ethernet(KEYENCE),Gateway
(12) KOYO KOSTAC/DL
(13) JTEKT TOYOPUC-PC
(14) SHARP JW
(15) SHINKO TECHNOS CONTROLLER
(16) CHINO MODBUS device(formerly CHINO Controllers (MODBUS)))
(17) TOSHIBA PROSEC T/V
(18) Ethernet(TOSHIBA nv), Gateway
(19) SHIBAURA MACHINE TCmini(formerly TOSHIBA MACHINE TCmini)
(20) Panasonic MINAS A4
(21) Panasonic MINAS A5
(22) PANASONIC MEWNET-FP
(23) PANASONIC MEWTOCOL-7
(24) Ethernet(HITACHI IES), Gateway
(25) HITACHI IES HIDIC H(formerly HITACHI HIDIC H)
(26) HITACHI IES HIDIC H(Protocol2)(formerly HITACHI HIDIC H (Protocol2))
(27) Ethernet(HITACHI), Gateway
(28) HITACHI S10mini/S10V
(29) Hirata HNC
(30) FUJI Temperature Controller/Digital Controller(formerly FUJI PXR/PXG/PXH)
(31) FUJI MICREX-F
(32) FUJI MICREX-SX SPH
(33) Ethernet(FUJI),Gateway
(34) Muratec MPC
(35) Muratec MCR
(36) YASKAWA GL
(37) YASKAWA CP9200 (H)
(38) YASKAWA CP9300MS (MC compatible)
(39) YASKAWA MP2000/MP900/CP9200SH
(40) Ethernet(YASKAWA),Gateway
(41) Ethernet(YASKAWA MP3000), Gateway
(42) Ethernet(YASKAWA High Speed Ethernet Server), Gateway
(43) YOKOGAWA FA500/FA-M3/STARDOM
(44) YOKOGAWA GREEN/UT100/UT2000/UTAdvanced
(45) Ethernet(YOKOGAWA),Gateway
(46) RKC SR Mini HG (MODBUS)
(47) AB SLC500 AB 1:N connection
(48) AB MicroLogix
(49) Ethernet(AB MicroLogix), Gateway
(50) AB Control/CompactLogix
(51) Ethernet(AB), Gateway
(52) Ethernet(AB Tag), Gateway
(53) GE (SNP-X)
(54) Ethernet(LS Industrial Systems XGK), Gateway
(55) LS Industrial Systems MASTER-K
(56) MEI Nexgenie
(57) SICK Flexi Soft
(58) SIEMENS S7-300/400
(59) SIEMENS S7-200
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(60) Ethernet(SIEMENS S7),Gateway
(61) Ethernet(SIEMENS OP),Gateway
(62) Ethernet(CC-Link IE Field Network Basic)
(63) Ethernet(SLMP), Gateway
(64) MODBUS/RTU Master(formerly MODBUS/RTU)
(65) MODBUS/TCP Master, Gateway(formerly MODBUS/TCP, Gateway)
(66) MODBUS/RTU Slave
(67) MODBUS/TCP Slave, Gateway
(68) DeviceNet
(69) PROFIBUS DP
(70) Computer
(71) Ethernet(MICROCOMPUTER)

For the controllers compatible with GT SoftGOT2000, refer to the following.
➟GT SoftGOT2000 Version1 Operating Manual

(1) IAI X-SEL

(2) IAI robocylinder

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

-

GT27, GT25, GT23: 01.33.***
GT21, GS21: 01.35.***

• The connection to a CB type controller (PCON-CB, PCON-CFB, ACON-CB, or SCON-CB) is 
supported.

• The connection to the ELECYLINDER EC series is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The driver name has been changed.

GT27, GT25, GT23: 01.40.***
GT21, GS21: 01.41.***

The connection to the RCON series is supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(3) AZBIL SDC/DMC

(4) AZBIL DMC50

(5) OMRON SYSMAC

(6) Ethernet(OMRON),Gateway

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.02.*** The connection to AHC2001 is supported.

01.03.*** -

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to CP2E-E, CP2E-S, or CP2E-N is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(7) Ethernet(OMRON NJ/NX), Gateway

(8) OMRON THERMAC/INPANEL NEO

(9) OMRON Digital Temperature Controller

(10)Serial(KEYENCE)(formerly KEYENCE KV-700/1000)

01.06.*** -

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to CP2E-N is supported.

Version of communication 
driver Added and edited function Supported 

models

01.20.*** The connection to the NJ series (NJ501-□□□□, NJ301-□□□□, and NJ101-□□□□) is supported.

01.22.*** The connection using the CJ series EtherNet/IP unit (CJ1W-EIP21) is supported.

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

• The driver name has been changed.
• The connection to the NX series (NX1P2-□□□□□□□) is supported.

01.48.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.15.***
GT21, GS21: 01.16.***

-

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The connection to the THERMAC NEO series (E5AN-H, E5CN-H, E5EN-H, E5CN-HT, E5AN-HT, 
and E5EN-HT), E5□C series, and THERMAC R series is supported.

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

The connection to the E5□D series is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

• The driver name has been changed.
• The connection to the KV-7000 series is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to the KV-8000 series is supported.

Version of communication 
driver Added and edited function Supported 

models
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(11)Ethernet(KEYENCE),Gateway

(12)KOYO KOSTAC/DL

(13)JTEKT TOYOPUC-PC

(14)SHARP JW

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The connection to the KV-7000 series is supported.

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to the KV-8000 series is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -
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(15)SHINKO TECHNOS CONTROLLER

(16)CHINO MODBUS device(formerly CHINO Controllers (MODBUS)))

(17)TOSHIBA PROSEC T/V

(18)Ethernet(TOSHIBA nv), Gateway

(19)SHIBAURA MACHINE TCmini(formerly TOSHIBA MACHINE TCmini)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.39.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.12.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -
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(20)Panasonic MINAS A4

(21)Panasonic MINAS A5

(22)PANASONIC MEWNET-FP

(23)PANASONIC MEWTOCOL-7

01.06.*** -

01.36.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.36.***
GT21, GS21: 01.37.***

The connection to FP0H is supported.

GT27, GT25, GT23: 01.40.***
GT21, GS21: 01.41.***

The connection to FP-XH is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

- (first edition)

Version of communication 
driver Added and edited function Supported 

models
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(24)Ethernet(HITACHI IES), Gateway

(25)HITACHI IES HIDIC H(formerly HITACHI HIDIC H)

(26)HITACHI IES HIDIC H(Protocol2)(formerly HITACHI HIDIC H (Protocol2))

(27)Ethernet(HITACHI), Gateway

(28)HITACHI S10mini/S10V

Version of communication 
driver Added and edited function Supported 

models

01.39.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.39.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.39.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.37.*** - (first edition)

01.39.*** The connection to the S10VE series is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -
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(29)Hirata HNC

(30)FUJI Temperature Controller/Digital Controller(formerly FUJI PXR/PXG/PXH)

(31)FUJI MICREX-F

(32)FUJI MICREX-SX SPH

(33)Ethernet(FUJI),Gateway

Version of communication 
driver Added and edited function Supported 

models

01.20.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.23.***
GT21, GS21: 01.25.***

• The driver name has been changed.
• The connection to the following temperature controllers is supported: PXF series (PXF4, PXF5, 

and PXF9) and PUM series (PUMA and PUMB).

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.09.*** The connection to MICREX-SX is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

-

Version of communication 
driver Added and edited function Supported 

models

01.09.*** The connection to MICREX-SX is supported.
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(34)Muratec MPC

(35)Muratec MCR

(36)YASKAWA GL

(37)YASKAWA CP9200 (H)

(38)YASKAWA CP9300MS (MC compatible)

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

01.23.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models

01.23.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models
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(39)YASKAWA MP2000/MP900/CP9200SH

(40)Ethernet(YASKAWA),Gateway

(41)Ethernet(YASKAWA MP3000), Gateway

(42)Ethernet(YASKAWA High Speed Ethernet Server), Gateway

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.14.***
GT21, GS21: 01.15.***

The connection to YASKAWA MP3000 series is supported.

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

01.42.*** - (first edition)

01.46.*** The connection to the YRC1000micro is supported.

Version of communication 
driver Added and edited function Supported 

models
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(43)YOKOGAWA FA500/FA-M3/STARDOM

(44)YOKOGAWA GREEN/UT100/UT2000/UTAdvanced

(45)Ethernet(YOKOGAWA),Gateway

(46)RKC SR Mini HG (MODBUS)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.06.*** The FA-M3 series supports the multiple CPU system.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.06.*** The FA-M3 series supports the multiple CPU system.

01.17.*** The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.25.*** The connection to the SRJ series (J-TI-A/B) is supported.

01.36.*** The connection to the PZ series (PZ400/PZ900) and GZ series (GZ400/GZ900) is supported.
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(47)AB SLC500 AB 1:N connection

(48)AB MicroLogix

(49)Ethernet(AB MicroLogix), Gateway

(50)AB Control/CompactLogix

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.10.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.10.*** -

Version of communication 
driver Added and edited function Supported 

models

01.26.** The connection to the AB MicroLogix series via EtherNet/IP is supported.

01.48.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -
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(51)Ethernet(AB), Gateway

(52)Ethernet(AB Tag), Gateway

(53)GE (SNP-X)

(54)Ethernet(LS Industrial Systems XGK), Gateway

(55)LS Industrial Systems MASTER-K

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.16.***
GT21, GS21: 01.18.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

01.48.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.05.*** The AB native tag is supported.

01.17.*** The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

01.45.*** Bit-specified word devices of DINT, REAL, and UDINT data types are supported.

01.48.*** The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

Version of communication 
driver Added and edited function Supported 

models

01.42.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -
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(56)MEI Nexgenie

(57)SICK Flexi Soft

(58)SIEMENS S7-300/400

(59)SIEMENS S7-200

01.10.*** -

Version of communication 
driver Added and edited function Supported 

models

01.06.*** -

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.05.***
GT21, GS21: 01.04.***

The connection to FX3-CPU320002 is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.05.***
GT21, GS21: 01.04.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

Version of communication 
driver Added and edited function Supported 

models
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(60)Ethernet(SIEMENS S7),Gateway

(61)Ethernet(SIEMENS OP),Gateway

(62)Ethernet(CC-Link IE Field Network Basic)

(63)Ethernet(SLMP), Gateway

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

The connection to the SIMATIC S7-200 SMART series and the SIMATIC S7-200 CN series is 
supported. (GT21)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.17.*** The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.12.*** -

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.25.***
GT21, GS21: 01.27.***

The connection to the SIMATIC S7-200 SMART series and the SIMATIC S7-200 CN series is 
supported. (GT21)

GT27, GT25, GT23: 01.39.***
GT21, GS21: 01.40.***

• The connection to the SIMATIC S7-1500 series is supported.
• The connection to the SIMATIC S7-200 CN series is supported. (GT27, GT25, and GT23)

Version of communication 
driver Added and edited function Supported 

models

01.18.*** The CC-Link IE Field Network Basic connection is supported.

GT27, GT25, GT23: 01.20.***
GT21, GS21: 01.22.***

-

Version of communication 
driver Added and edited function Supported 

models

01.12.*** -

Version of communication 
driver Added and edited function Supported 

models
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GT21 GS21GS25
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(64)MODBUS/RTU Master(formerly MODBUS/RTU)

(65)MODBUS/TCP Master, Gateway(formerly MODBUS/TCP, Gateway)

(66)MODBUS/RTU Slave

(67)MODBUS/TCP Slave, Gateway

GT27, GT25, GT23: 01.15.***
GT21, GS21: 01.16.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.31.***
GT21, GS21:01.33.***

The connection to the master station on a CC-Link IE TSN network is supported.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The driver name has been changed.

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

GT27, GT25, GT23: 01.08.***
GT21, GS21: 01.09.***

-

GT27, GT25, GT23: 01.17.***
GT21, GS21: 01.19.***

The connection using the GOT Ethernet communication unit is supported. (GT27 and GT25 only)

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The driver name has been changed.

GT27, GT25, GT23: 01.26.***
GT21, GS21: 01.28.***

The connection to multiple controllers with unit ID 255 is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The MODBUS/RTU slave connection is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27, GT25, GT23: 01.19.***
GT21, GS21: 01.21.***

The MODBUS/TCP slave connection is supported.

Version of communication 
driver Added and edited function Supported 

models

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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(68)DeviceNet

(69)PROFIBUS DP

(70)Computer

(71)Ethernet(MICROCOMPUTER)

Version of communication 
driver Added and edited function Supported 

models

01.10.*** -

01.16.*** The HMS communication module is supported. (Product name: ABCC-M40-DEV, article number: 
AB6909-C)

Version of communication 
driver Added and edited function Supported 

models

01.10.*** -

01.16.*** The HMS communication module is supported. (Product name: ABCC-M40-DPV1, article number: 
AB6910-C)

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

GT27, GT25, GT23: 01.03.***
GT21, GS21: 01.02.***

-

Version of communication 
driver Added and edited function Supported 

models

01.00.*** - (first edition)

01.03.*** -

01.12.*** -

GT27, GT25, GT23: 01.26.*** Specifying a destination module I/O number to be returned from the GOT to the host station is 
supported.

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25

GT27 GT25 GT23

SoftGOT2000
GT21 GS21GS25
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12.17.3 Functions of GT Designer3

■1 Functions for the project

■2 Functions for editing the screen, figure, and object

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

The interaction with iQ Works is supported. 1.104J

Project format "*.GTCNV" has been added.
1.108N

Registering device comments or device definitions as a comment group is supported.

Importing global labels is supported. 1.117X

Importing AB native tags is supported.
1.118Y

Verifying the items set in each screen (screen property, object, or others) is supported.

Labels (GT Designer3) are supported.
1.122C

Assigning a security key is supported.

Global labels created with MT Developer2 is supported.
1.123D

The system label Ver.2 is supported.

Printing label group data is supported. 1.126G

String-type system labels are supported.

1.144A

Importing labels created on GX Works3, GX Works2, or MT Developer2 as labels (GT 
Designer3) is supported.

Array-type labels (GT Designer3) are supported.

Copying data from a cell in the [Label Group] window to one in Excel (and vice versa) is 
supported.

Outputting the MELSOFT iQ AppPortal information file is supported. 1.155M

The bit specification of word devices for system labels or labels (GT Designer3) is 
supported. 1.170C

System labels Ver.1 and Ver.2 of the Unicode string type are supported.

1.175H
Global labels of the string type or Unicode string type are supported.

String-type AB native tags are supported.

Importing OMRON NJ tags is supported.

Applying the offset setting to OMRON NJ tags is supported. 1.185T

Importing global labels from a GX Works3 project is supported.
1.195D

Registering the labels (GT Designer3) created from profile (CSP+) data is supported.

Importing OPC UA tags is supported. 1.215Z

The double-precision real number system labels are supported.

1.235V

The double-precision real number global labels are supported.

The global labels of Motion Control Setting Function are supported.

The 8-bit or 64-bit labels (GT Designer3) are supported.

The 8-bit or 64-bit OMRON NJ tags are supported.

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

• The objects support registering the characters (text type [Text]) for a comment group and 
making the registered comment be automatically referred.

• For the following figures, the setting items have been divided into tabs.
Line, freeform line, rectangle, polygon, circle, and piping

1.112S

The copy direction setting is supported for the consecutive copy. 1.130L

Reading 24-bit PNG files is supported. 1.155M

Anchoring a figure or object to align figures and objects is supported. 1.170C

Editing objects with fixed shape frame widths is supported. 1.175H
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■3 Functions for the search and replacement

■4 Functions for the display

Customizing screen designs is supported. 1.215Z

Expanding the base screen size is supported. 1.225K

Incrementing the comment group number, comment number, user ID, and move 
destination ID using the consecutive copy function are supported. 1.235V

Copying a base screen or window screen to a mobile screen is supported. 1.265B

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

• Device list, text list
Report screens have been added as a search target.

• Batch edit
Report screens have been added as a batch edit target.

1.104J

Importing and exporting the device batch edit data are supported. 1.108N

Setting the display type in the device batch edit is supported. 1.126G

Displaying the data browser from the [Search/Replace] menu is supported. 1.130L

Listing the OMRON NJ tags in the device list is supported.
1.175H

OMRON NJ tags have been added as a batch edit target.

The unit numbers and axis numbers have been targeted for the batch edit.

1.185TSearching the whole project at a batch edit is supported.

Searching the specified scripts at a batch edit of channel numbers is supported.

Searching the scripts of a script parts object at a batch edit is supported. 1.195D

The device search is supported. 1.205P

Listing OPC UA tags in the device list is supported.

1.215ZOPC UA tags have been added as a batch edit target.

The device search supports exporting the search result data.

8-bit and 64-bit devices have been added as search targets.

1.235V
Listing 8-bit or 64-bit devices in the device list are supported.

8-bit and 64-bit devices have been added as a device batch edit.

[IP Address List] window is supported.

Displaying a comment (character string) on the data browser is supported. 1.260W

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

Switching the states of the object displayed on the screen editor is supported. 1.108N

The [Verify Result] window is supported. 1.118Y

The display language switching is supported. 1.122C

The buttons to expand and collapse all attribute items have been added to the property 
sheet. 1.134Q

Displaying guidelines for a table figure is supported.
1.144A

Displaying guidelines for enlarging or reducing an object is supported.

[25%] and [Whole Screen] have been added to specify the zoom magnification. 1.165X

Displaying the scroll bar areas for editing the expanded base screens is supported. 1.225K

[IP Address List] window is supported. 1.235V

Added and edited function Version corresponding with GT Designer3
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■5 Functions for communication with GOT

■6 Functions for the window display

■7 Tools and option

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

The communication between the GOT and a personal computer by the wireless LAN 
function is supported. 1.108N
Installing CoreOS with a data storage is supported.

The communication between the GOT and a personal computer via an RCPU is supported. 1.118Y

Writing resource data is supported.
1.165X

The [CSP+ for iQSS Data Write] command has been moved from the [Tools] menu.

Writing, reading, and verifying data through the Ethernet extended port or Ethernet 
standard port 2 of the GOT are supported. 1.175H

Writing package data to multiple GOTs in one go is supported. 1.185T

Added and edited function Version corresponding with GT Designer3

Displaying errors recorded in the GOT and their causes and corrective actions is 
supported. 1.130L

The GOT internal device monitor is supported. 1.175H

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

The simulation function supports MT Simulator2. 1.108N

Restructuring the project data when saving the project is supported. 1.112S

Writing iQSS profile data is supported. 1.126G

The simulation function supports GT2705-V.
1.130L

The simulation function supports referring to resource data.

The simulation function supports GT2104-P. 1.131M

The simulation function supports GT2105-Q.

1.144ASimulating the connection to RnSFCPU is supported.

Simulating the connection to R64MTCPU is supported.

The [iQSS Profile Data Write] command in the menu is renamed with [CSP+ for iQSS Data 
Write]. 1.150G

The [CSP+ for iQSS Data Write] command has been moved to the [Communication] menu.
1.165X

Disabling IME to specify a device is supported.

The simulation function supports GT2107-W.

1.170CThe simulation function supports using a keyboard in the simulation of GT21.

The simulation function supports importing or exporting a free registration list of the device 
monitor function.

The simulation function supports GT25-W. 1.175H

The simulation function supports global labels when GX Simulator3 is connected. 1.190H

Specifying CPU numbers and module numbers with devices is supported.
1.215Z

Retaining GOT internal device data at intervals is supported.

The device monitor of the simulation function supports monitoring of 8-bit and 64-bit 
devices. 1.235V

The GOT offline monitor is supported. 1.236W

The simulation function supports GT2512-WX and GS21-W-N. 1.250L

Respectively displaying the sizes of GT SoftGOT2000 screen data and project data stored 
in the storage memory (ROM) and in the operation memory (RAM) is supported. 1.280S
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■8 Functions for the window display

■9 Help

■10 Others

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

Added and edited function Version corresponding with GT Designer3

- (first edition) 1.100E

Displaying Help with e-Manual Viewer is supported. 1.155M

Added and edited function Version corresponding with GT Designer3

GT Designer3 is compatible with Windows8.1.
1.108N

The input assist supports the system label.

The input assist supports the device definitions for FR-A800, FR-A700, FR-F700, FR-
F700P, FR-F700PJ, FR-E700, and sensorless servo. 1.112S

The input assist supports the global label.
1.117X

The input assist supports the device definitions for FR-F800.

The input assist supports the AB native tag. 1.118Y

The input assist supports the label (GT Designer3).
1.122CSupport for GT Designer3 running on Windows XP Service Pack2 and Windows 2000 has 

ended.

Narrowing the search scope of the sample projects by category is supported when a 
screen is created by utilizing existing data. 1.130L

GT Designer3 is compatible with Windows 10. 1.155M

GT Designer3 is compatible with the Italian version of Windows OSs. 1.165X

The input assist supports the bit specification of word devices for system labels or labels 
(GT Designer3). 1.170C

The GOT Ethernet setting has been added to the new project wizard.

1.175HThe input assist supports the OMRON NJ tag.

Editing a sound file by using speech synthesis is supported.

The graphics setting has been added to the new project wizard.
1.185T

The usability of the screen utilization has been improved.

Utilizing an add-on project is supported. 1.205P

The input assist supports OPC UA tags.
1.215Z

Specifying CPU numbers and module numbers with devices is supported.

The input assist supports the device definitions for FR-A800 Plus (CRN and R2R).
1.225K

Notifying a change in the global labels is supported.

MELSEC iQ-L supports the global label.
1.230Q

The input assist supports the device definitions for MELSEC iQ-L and FR-E800 series.

Support for GT Designer3 running on Windows XP and Windows Vista has ended. 1.235V

GT Designer3 is compatible with Windows 11. 1.275M

Support for GT Designer3 running on Windows 8.1, Windows 8, and Windows 7 has 
ended. 1.295H
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12.17.4 Drawing Setting

■1 Functions for the edit and settings of the screen

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3

- (first edition) Standard system application 01.00.*** 1.100E

Report function
• Settings for the report screen are added.

• Standard system application
• Report
• Printer (PictBridge)
• Printer (Serial)

01.01.*** 1.104J

GOT type setting
• GT27**-X, GT25**-V, and GT2103-P have been added as 

a GOT type.
• The setup direction setting has been added.
• The backlight color setting for GT21 has been added.
• The graphics accelerator setting has been added.

Standard system application
• Standard system application
• Graphic Acceleration Driver

(only for using the graphics accelerator)

01.03.***
1.112S

CoreOS
(only for using the graphics accelerator) E

Base screen and window screen
• The setting range of the screen number has been 

changed. (0 to 32767)
Standard system application 01.03.*** 1.112S

GOT type setting
• The vertical installation setting for GT27, GT25, and GT23 

is supported.
Standard system application 01.04.*** 1.117X

GOT type setting
• GT25**-S and GT2104-R have been added as a GOT 

type.
Standard system application 01.06.*** 1.122C

Report function
• The maximum number of settable report screens has 

been changed to 32.
• The maximum number of settable data collection times 

has been changed to 1000.
• The maximum number of settable repeat times has been 

changed to 999.
• The footer is supported. (Not applicable to GT21)
• The alarm print is supported. (Not applicable to GT21)
• The text print is supported. (Not applicable to GT21)

• Standard system application
• Report

01.10.*** 1.130L

GOT type setting
• GT2705-V has been added as a GOT type.
• Switching between the Simplified Chinese character 

codes used for the outline font is supported.
• A setting to use the easily-distinguishable font for the 

numeral zero and the capital letter I is supported.

• Standard system application
• Standard Font
• Outline Font (Gothic) (Chinese(Simplified))
• Outline Font (Kaisho) (Chinese(Simplified))

01.10.*** 1.130L

GOT type setting
• GT2104-P has been added as a GOT type. Standard system application 01.11.*** 1.131M

Report function
• GT21 supports the footer.
• GT21 supports the alarm print.
• GT21 supports the text print.

• Standard system application
• Report

01.12.*** 1.134Q

Superimpose window
• A setting to close a target window upon switching base 

screens has been added.
Standard system application 01.12.*** 1.134Q

GOT type setting
• GT2105-Q has been added as a GOT type. Standard system application 01.14.*** 1.144A

GOT Mobile function
• The mobile screen setting has been added.

• Standard system application
• GOT Mobile Setting

01.14.***
1.144A

CoreOS L

GOT type setting
• GT2107-W has been added as a GOT type.
• Selecting a typeface for the outline font is supported. (Only 

available to GT2107-W)

Standard system application 01.19.*** 1.170C

GOT type setting
• GT25**-WX and GT25**-W have been added as a GOT 

type.
Standard system application 01.20.*** 1.175H
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■2 Functions for the common setting

GOT type setting
• The graphics setting has been added.

Standard system application 01.23.*** 1.185T

The screen design setting has been added. Standard system application 01.23.*** 1.185T

Report function
• The report screen setting dialog has been revamped.
• The operation log has been added as an output target.
• The file output settings are supported.
• The page header and page footer settings are supported.

• Standard system application
• Report

01.26.*** 1.200J

GOT Mobile function
• The setting range of the mobile screen size has been 

extended.

• Standard system application
• GOT Mobile Setting

01.26.*** 1.200J

Report function
• Saving report files into the network drive is supported.

• Standard system application
• Report

01.27.*** 1.205P

Customizing screen designs is supported. Standard system application 01.29.*** 1.215Z

GOT type setting
• Setting the base screen size expansion is supported.

Base Screen Size Expansion 01.32.*** 1.225K

Report function
• The maximum number of settable report screens has 

been changed to 99.
Report 01.32.*** 1.225K

Report function
• Outputting a report from a Brightek's serial printer is 

supported.
(GT21, GS21)

• Standard system application
• Report

01.36.*** 1.235V

GOT type setting
• GS21**-W-N has been added as a GOT type.
• Selecting a typeface for the outline font is supported. 

(Only available to GS21-W-N)

Standard system application 01.39.*** 1.250L

Report function
• Process notification device settings have been added.

• Standard system application
• Report

01.43.*** 1.270G

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3

- (first edition) Standard system application 01.00.*** 1.100E

Hard copy
• Settings for the printer output (PictBridge and serial) are 

added.

• Standard system application
• Printer (PictBridge)
• Printer (Serial)

01.01.*** 1.104J

KANA-KANJI Conversion
• Settings for the Kana-kanji conversion function are added 

to the GOT environmental settings.

• Standard system application
• KANA-KANJI Conversion

01.01.*** 1.104J

Wireless LAN function
• The wireless LAN setting is added to the GOT setup.
• Settings for the wireless LAN are added to the I/F 

communication setting.
• Settings for the wireless LAN are added to the gateway 

function connection setting.
• Settings for the wireless LAN are added to the GOT 

setting list.

• Standard system application
• Wireless LAN
• Gateway (server and client)
• Gateway (mail)
• Gateway (FTP server)
• Gateway (FTP client)

01.02.***
1.108N

BootOS D

Comment group
• Switching the comment number notations (between 

decimal and hexadecimal) is supported.
Standard system application 01.02.*** 1.108N

User alarm observation
• The setting range for the alarm observation cycle has 

been changed to 0.1 second to 3600 seconds. (GT27 and 
GT SoftGOT2000)

Standard system application 01.02.*** 1.108N

MES interface function
• The MES interface function settings have been added.

• Standard system application
• MES Interface

01.02.***
1.108N

BootOS D

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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Screen switching/windows (GOT environmental setting)
• The setting to specify the screen number of the window 

screen to be hidden has been added.
• The setting to enable screen switching by device while the 

screen is being touched has been added.

Standard system application 01.03.*** 1.112S

System information (GOT environmental setting)
• The backlight color selection for 3-color control has been 

added.
Standard system application 01.03.*** 1.112S

Brightness adjustment mode
• The brightness adjustment mode setting has been added 

to the GOT setup.

Standard system application 01.03.***
1.112S

BootOS E

POWER LED shutoff
• The POWER LED setting has been added to the GOT 

setup.
Standard system application 01.03.*** 1.112S

System alarm observation
• Recording global label names is supported. Standard system application 01.04.*** 1.117X

Script
• The global label is supported. Standard system application 01.04.*** 1.117X

Backup/restoration
• GT21 supports this function.

• Standard system application
• Backup/restoration

01.05.*** 1.118Y

System alarm observation
• Recording AB native tag names is supported. Standard system application 01.05.*** 1.118Y

Script
• The AB native tag is supported. Standard system application 01.05.*** 1.118Y

Script
• Labels (GT Designer3) are supported. Standard system application 01.06.*** 1.122C

Controller setting
• The buffer memory unit No. switching is supported. Standard system application 01.06.*** 1.122C

IP filter function
• The IP filter settings have been added to the controller 

setting.
• The IP filter settings have been added to the connection 

settings for the gateway function.

Standard system application 01.06.***

1.122C
CoreOS H

System launcher
• The system launcher setting has been added to the GOT 

setup.

• Standard system application
• System launcher

01.08.*** 1.126G

iQSS utility
• The iQSS utility setting has been added to the GOT setup.

• Standard system application
• iQSS utility

01.08.*** 1.126G

User alarm observation
• Unicode has been added as a character code. Standard system application 01.08.*** 1.126G

Logging
• Unicode has been added as a character code. Standard system application 01.08.*** 1.126G

Recipe
• Unicode has been added as a character code. Standard system application 01.08.*** 1.126G

Script
• The following file operation functions are supported.

file_getfolderlist, file_unilineread, #pragma 
use_character_code unicode

• The following string operation functions are supported.
str_uniscanf, str_uniprintf, str_unistrlen, str_unistrmid, 
str_lc2uni, str_uni2lc

Standard system application 01.08.*** 1.126G

I/F communication setting
• Assigning a channel number ranging from 5 to 8 to the 

standard I/F-1 is supported.
Standard system application 01.08.*** 1.126G

Video/RGB input
• A setting to use GT27-R2 is supported.

• Standard system application
• Video/RGB (Object)

01.10.***
1.130L

BootOS N

User alarm observation
• Printing alarm details is supported. (Not applicable to 

GT21)
Standard system application 01.10.*** 1.130L

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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Operation log (GOT environmental setting)
• A setting to log the previous device value with each touch 

switch operation has been added.
Standard system application 01.12.*** 1.134Q

Comment group
• Collectively copying, cutting, and pasting multiple cells are 

supported.
Standard system application 01.12.*** 1.134Q

Script
• Setting the execution cycle time in units of 100 ms is 

supported.
Standard system application 01.12.*** 1.134Q

Operation log (GOT environmental setting)
• The GOT network interaction function and the GOT Mobile 

function have been added as the operation log target.
• A setting to log operations performed on a GOT Mobile 

function client has been added.

Standard system application 01.14.*** 1.144A

Wireless LAN function
• The access point mode has been added as an operation 

mode.

• Standard system application
• Wireless LAN

01.14.***
1.144A

BootOS D

System alarm observation
• A setting to monitor errors of a GOT Mobile function client 

has been added.
Standard system application 01.14.*** 1.144A

Controller setting
• The setting range of the port number has been changed in 

the Ethernet setting for the MODBUS/TCP connection (1 
to 65535).

Standard system application 01.14.*** 1.144A

GOT network interaction function
• The GOT network interaction function setting has been 

added.

• Standard system application
• GOT Network Interaction

01.14.*** 1.144A

GOT Mobile function
• The GOT Mobile function setting has been added.

• Standard system application
• GOT Mobile Setting

01.14.***
1.144A

CoreOS L

Logging
• The setting dialog has been revamped. Standard system application 01.15.*** 1.150G

Screen switching/windows (GOT environmental setting)
• The setting to specify the stacking order of overlap 

windows has been added.
• The setting to disable the touch operation on the window 

screen that is behind an overlap window has been added.

Standard system application 01.16.*** 1.155M

Controller setting
• The menu name [Q Redundant] has been changed to 

[MELSEC Redundant].
Standard system application 01.17.*** 1.160S

GOT Mobile function
• The ANDON setting has been added. Standard system application 01.17.*** 1.160S

Comment group
• Setting Windows fonts is supported. Standard system application 01.18.*** 1.165X

GOT Mobile function
• The historical data list display, statistics bar graph, 

statistics pie graph, scatter graph, and graphical meter 
are supported.

• Standard system application
• GOT Mobile Setting

01.18.*** 1.165X

User alarm observation
• Setting the device to change the status of an alarm to 

"Checked" is supported.
• Setting the device to notify that the status of an alarm has 

been changed to "Checked" is supported.

Standard system application 01.19.*** 1.170C

Operation log (GOT environmental setting)
• The setting to log operations performed on a numerical 

input or a text input has been added.
Standard system application 01.20.*** 1.175H

GOT internal device monitor of the GOT diagnostics 
function (GOT setup)
• The setting to enable the GOT internal device monitor has 

been added.

Standard system application 01.20.*** 1.175H

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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VNC server (GOT setup)
• This function is supported by GT2107-W.

• Standard system application
• VNC server

01.20.*** 1.175H

System launcher (GOT setup)
• The setting to display the servo network configuration has 

been added.

• Standard system application
• System Launcher (Basic)
• System Launcher (Servo Network)

01.20.*** 1.175H

Ethernet interface setting (GOT Ethernet setting)
• The IP address settings have been moved to the [GOT IP 

Address Setting] tab.
• The default gateway and other common settings have 

been moved to the [GOT Ethernet Common Setting] tab.
• The IP filter settings have been moved to the [IP Filter 

Setting] tab.

Standard system application 01.20.*** 1.175H

Controller setting
• The IP filter settings have been moved to the [GOT 

Ethernet Setting] window.
Standard system application 01.20.*** 1.175H

Barcode (Peripheral setting)
• The USB barcode settings have been added.

• Standard system application
• Bar Code (USB)

01.20.*** 1.175H

I/F communication setting
• The Ethernet interface settings have been moved to the 

[GOT Ethernet Setting] window.
Standard system application 01.20.*** 1.175H

Trigger action
• Selecting the sound output in the action setting is 

supported.
• Playing the sound files specified in the playlist is 

supported.

Standard system application 01.20.*** 1.175H

Time action
• The setting range of the sound file number has been 

changed to 1 to 500.
Standard system application 01.20.*** 1.175H

Hard copy
• The setting to use the image file output and the printer 

output is supported.
Standard system application 01.20.*** 1.175H

Script
• The OMRON NJ tag is supported.

Standard system application 01.20.*** 1.175H

GOT Mobile function
• The setting to clear the values of the GOT Mobile devices 

(VGD and VGB) for the target client upon connection is 
supported.

• Standard system application
• GOT Mobile Setting

01.20.*** 1.175H

Sound output function
• The maximum number of sound files has been expanded 

to 500 files.
• Settings to play, stop, and mute the sound are supported.
• [Message], [Sound Effect], and [Melody] have been added 

as a sound type.

• Standard system application
• Sound Output

01.20.*** 1.175H

Sound output function
• The WAV file format conversion is supported.
• Setting [File No.] in the [Create New Sound File] or [Edit 

Sound File] dialog is supported.

• Standard system application
• Sound Output

01.22.*** 1.180N

Operation log (GOT environmental setting)
• The operator management has been added as the 

operation log target.
Standard system application 01.23.*** 1.185T

Script
• The project script has been added as the screen-related 

setting to be utilized automatically at the screen utilization.
Standard system application 01.23.*** 1.185T

GOT Mobile function
• The hard copy function is supported.

• Standard system application
• GOT Mobile Setting

01.23.*** 1.185T

Recipe
• Saving recipe data to the SRAM user area is supported.
• The date format setting has been moved to the [Basic] tab.

• Standard system application 01.24.*** 1.190Y

Logging
• Enabling the SRAM power-failure backup function for a 

maximum of 20 logging settings is supported.
• Standard system application 01.24.*** 1.190Y

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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IP filter function
• GT21 supports this function.

Standard system application 01.25.*** 1.195D

Comment group
• Displaying comments from a comment text file is 

supported.
Standard system application 01.25.*** 1.195D

GOT Mobile function
• File manipulations are supported.

• Standard system application
• GOT Mobile Setting

01.25.*** 1.195D

Controller setting
• The channel setting window has been revamped. Standard system application 01.26.*** 1.200J

Operation log (GOT environmental setting)
• The file print has been added as an operation log target.
• The object operation name settings are supported.
• Setting an item to be output using the report function is 

supported.

Standard system application 01.26.*** 1.200J

Barcode (Peripheral setting)
• Specifying values as the header or terminator is 

supported.

• Standard system application
• Bar Code (Serial)

01.26.*** 1.200J

RFID (Peripheral setting)
• Specifying values as the header or terminator is 

supported.

• Standard system application
• RFID

01.26.*** 1.200J

Printer (Peripheral setting)
• The Ethernet printer setting is supported.

• Standard system application
• Printer (ESC/P-R)

01.26.***
1.200J

BootOS AJ

Hard copy
• The Ethernet printer setting is supported.

Standard system application 01.26.***
1.200J

BootOS AJ

Network drive
• The network drive settings have been added to the GOT 

setup.

• Standard system application
• Network Drive

01.27.***

1.205P
CoreOS L

BootOS AK

Logging
• Saving logging files into the network drive is supported. Standard system application 01.27.*** 1.205P

Hard copy
• Saving image files into the network drive is supported. Standard system application 01.27.*** 1.205P

Controller setting
• [Ethernet Controller Setting] has been renamed to 

[Connected Ethernet Controller Setting].
- - 1.210U

Printer (Peripheral setting)
• The Ethernet printer setting (PCL5) is supported.

• Standard system application
• Printer(PCL5)

01.29.*** 1.215Z

Hard copy
• The Ethernet printer setting (PCL5) is supported. Standard system application 01.29.*** 1.215Z

Multi-channel
• Channel No. 1 to 4 settings are supported for GT 

SoftGOT2000.
Standard system application 01.29.*** 1.215Z

Operation log (GOT environmental setting)
• Recording the operator name with the character string 

stored in the device is supported.
Standard system application 01.32.*** 1.225K

8-bit and 64-bit devices are supported. - - 1.235V

Controller setting
• Displaying the controller and IP address in the tree view 

when the Ethernet connection is used.
- - 1.235V

Script
• The global labels of Motion Control Setting Function are 

supported.
Standard system application 01.34.*** 1.235V

Operation log (GOT environmental setting)
• GT2107-W supports this function. Standard system application 01.38.*** 1.245F

Controller setting
• GS21-W-N supports the multidrop (slave) connection.

• Standard system application
• Multidrop(Slave)

01.39.*** 1.250L

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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■3 Functions for the edit and settings of the figure

■4 Functions for the edit and settings of the object

Operation log (GOT environmental setting)
• GS21-W-N supports this function. Standard system application 01.39.*** 1.250L

VNC server (GOT setup)
• GS21-W-N supports this function.

• Standard system application
• VNC Server

01.39.*** 1.250L

Screen switching/windows (GOT environmental setting)
• The setting to output an overlap window via HDMI/RGB 

has been added.
Standard system application 01.39.*** 1.255R

GOT network interaction function
• The model selection for the master GOT is supported.

• Standard system application
• GOT Network Interaction

01.42.*** 1.265B

Mail send function
• Setting a DNS server is supported.
• Specifying an SMTP server and POP3 server with the host 

name is supported.

• Standard system application
• Gateway (mail)

01.43.*** 1.270G

User alarm observation
• Outputting alarms (when checked) using the report 

function is supported.

• Standard system application
• Report

01.43.*** 1.270G

Kana-Kanji/Pinyin conversion
• Entering Simplified Chinese characters using Pinyin 

conversion is supported.

• Standard system application
• Kana-Kanji/Pinyin conversion

01.46.*** 1.280S

Hard copy
• Outputting PDF format files is supported.
• Specifying an output target screen is supported.
• Outputting multiple screen images is supported.

• Standard system application
• Hard copy PDF output function

01.47.*** 1.285X

Backup/restoration
• GT SoftGOT2000 (Multiple channels) is supported.

• Standard system application
• Backup/restoration

01.47.*** 1.285X

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3

- (first edition) Standard system application 01.00.*** 1.100E

Line, freeform line, rectangle, polygon, circle, and piping
• The setting items have been divided into tabs. Standard system application 01.03.*** 1.112S

Text
• Registering text to a comment group and converting the 

text figure to a simple comment display object are 
supported.

Standard system application 01.04.*** 1.117X

Figure
• Changing the coordinates of a grouping of figures on the 

property sheet or toolbar is supported.
Standard system application 01.12.*** 1.134Q

Figure
• Independently editing each figure of a grouping is 

supported.
Standard system application 01.14.*** 1.144A

Table
• The table setting has been added. Standard system application 01.14.*** 1.144A

Figure
• The maximum number of characters for a figure name has 

been changed to 100.
Standard system application 01.23.*** 1.185T

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3

- (first edition) Standard system application 01.00.*** 1.100E

Text input
• Settings for the KANA-KANJI conversion are added.

• Standard system application
• KANA-KANJI Conversion

01.01.*** 1.104J

Print object
• Settings for the numerical print, bit comment print, and 

word comment print are added.

• Standard system application
• Report

01.01.*** 1.104J

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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Object
• Selecting the ON display or OFF display is available for 

displaying and hiding the object.
Standard system application 01.02.*** 1.108N

Key code switch
• The setting not to specify the character code is supported. Standard system application 01.02.*** 1.108N

Slider
• The slider settings have been added. Standard system application 01.02.*** 1.108N

Special function switch
• The R motion monitor is supported.
• The CNC monitor is supported.
• The CNC data I/O is supported.
• The CNC machining program edit is supported.
• The recipe operation is supported.

Standard system application 01.04.*** 1.117X

Key code switch
• The key code (FFBFh) for displaying the first alarm is 

supported.
Standard system application 01.04.*** 1.117X

Alarm display (user), Alarm display (system)
• Indirectly specifying the display start row is supported.
• The setting ranges for the numbers of the displayed rows 

and digits have been expanded.
• Setting items of [Flow all] and [Flow the selected row] have 

been added.
• Externally outputting the alarm status and the number of 

displayed alarms is supported.

Standard system application 01.04.*** 1.117X

Logging
• The string has been added as a device type. Standard system application 01.06.*** 1.122C

Historical data list
• The string has been added as a device type. Standard system application 01.06.*** 1.122C

Panelmeter
• The beginning angle and end angle settings have been 

added.
• The triangle and the inverted triangle have been added as 

a needle shape.
• Specifying the distance from the meter center to the 

drawing start position of the needle is supported.

Standard system application 01.06.*** 1.122C

Special function switch
• The system launcher is supported.
• The iQSS utility is supported.

Standard system application 01.08.*** 1.126G

Key code switch
• Unicode has been added as a character code. Standard system application 01.08.*** 1.126G

Text display, text input
• Unicode has been added as a character code. Standard system application 01.08.*** 1.126G

Slider
• GT21 supports this function. Standard system application 01.08.*** 1.126G

Document display
• The setting range of the document ID has been expanded. 

(1 to 32767)
• Specifying the document ID by setting a device is 

supported.

Standard system application 01.08.*** 1.126G

Key code switch
• The key code (FFBAh) for starting the sequence program 

monitor (R ladder) from the alarm display (user) is 
supported.

Standard system application 01.09.*** 1.127H

Special function switch
• The motion program editor is supported.
• The motion program I/O is supported.

Standard system application 01.10.*** 1.130L

Print object
• Settings for the text print have been added. (Not 

applicable to GT21)

• Standard system application
• Report

01.10.*** 1.130L

Video/RGB display object
• Settings for the video/RGB display object have been 

added.

• Standard system application
• Video/RGB (Object)

01.10.***
1.130L

BootOS N

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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Object
• Changing the coordinates of a grouping of objects on the 

property sheet or toolbar is supported.
Standard system application 01.12.*** 1.134Q

Object
• Independently editing each object of a grouping is 

supported.
Standard system application 01.14.*** 1.144A

Hyperlink
• The hyperlink setting has been added. Standard system application 01.14.*** 1.144A

Special function switch
• The file management function is supported. Standard system application 01.15.*** 1.150G

Text display, text input
• HQ fonts have been added. Standard system application 01.15.*** 1.150G

Special function switch
• The CNC monitor 2 is supported.
• The drive recorder is supported.
• The recipe data operation is supported.

Standard system application 01.16.*** 1.155M

Recipe Display (Record List)
• The settings for the recipe display (record list) have been 

added.
Standard system application 01.16.*** 1.155M

Graphical Meter
• The graphical meter settings have been added. Standard system application 01.16.*** 1.155M

Special function switch
• The CC-Link IE Field Network diagnostics is supported. Standard system application 01.18.*** 1.165X

Switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Bit Switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Word Switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Go To Screen Switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Change Station No. Switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Key window display switch
• Setting the offset device for the lamp function is 

supported.
Standard system application 01.19.*** 1.170C

Switch
• The sound output has been added to the switch action 

setting.
Standard system application 01.20.*** 1.175H

Special function switch
• The output destination setting for the hard copy is 

supported.
Standard system application 01.20.*** 1.175H

Text input
• The write completion device setting is supported.

Standard system application 01.20.*** 1.175H

Document display
• The setting to display a PDF file as-is is supported.

• Standard system application
• Document Display (PDF)

01.20.*** 1.175H

Object
• The maximum number of characters for an object name 

has been changed to 100.
Standard system application 01.23.*** 1.185T

Numerical display, numerical input
• Indirect specification of the number of decimal places is 

supported.
Standard system application 01.23.*** 1.185T

Document display
• The search and bookmark functions for PDF files are 

supported.

• Standard system application
• PDF Search/bookmark Function

01.23.*** 1.185T

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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Special function switch
• The servo amplifier graph is supported.

Standard system application 01.25.*** 1.195D

Script parts
• The script parts object settings have been added.

Standard system application 01.25.*** 1.195D

Recipe Display (Record List)
• GT21 supports this function.

Standard system application 01.25.*** 1.195D

Special function switch
• The file print is supported.

Standard system application 01.26.*** 1.200J

Alarm display (user)
• Placing key code switches together with this object is 

supported.
Standard system application 01.27.*** 1.205P

Alarm display (system)
• Placing key code switches together with this object is 

supported.
Standard system application 01.27.*** 1.205P

Document display
• Selecting a drive to store documents is supported.

• Document Display (Document Converter)
• Document Display (PDF)

01.28.*** 1.210U

Document display
• The setting to display a page by searching for a keyword 

is supported.
Document Display (PDF) 01.28.*** 1.210U

Slider
• The setting range of [Knob Width], [Knob Height], [Bar 

Width], and [Bar Height] of the object on a base screen 
has been extended.

Standard system application 01.32.*** 1.225K

Special function switch
• The R motion SFC monitor is supported.

Standard system application 01.33.*** 1.230Q

8-bit and 64-bit devices are supported. - - 1.235V

Special function switch
• The vision sensor monitor is supported.

• Standard system application
• Vision Sensor Monitor

01.34.*** 1.235V

Special function switch
• GT2107-W supports the operation log information.
• Drive recorder supports the settings through a Motion 

module (CC-Link IE TSN).

Standard system application 01.37.*** 1.245F

Parts display
• Image files (automatic update) have been added as a 

parts type.
Standard system application 01.37.*** 1.245F

Parts movement
• [Circle] has been added as a movement method.

Standard system application 01.37.*** 1.245F

Special function switch
• GS21-W-N supports the operation log information.

Standard system application 01.39.*** 1.250L

Special function switch
• The sequence program monitor (iQ-F ladder) is 

supported.
Standard system application 01.39.*** 1.255R

Key code switch
• The key code (FFC3h) for starting the sequence program 

monitor (iQ-F ladder) is supported.
Standard system application 01.39.*** 1.255R

Special function switch
• The servo amplifier graph supports the settings through a 

Motion module (CC-Link IE TSN).
Standard system application 01.40.*** 1.260W

Special function switch
• GT SoftGOT2000 supports the system launcher, drive 

recorder, and servo amplifier graph.
• The CC-Link IE TSN/CC-Link IE Field Network 

diagnostics is supported.

Standard system application 01.42.*** 1.265B

Text input
• Entering Simplified Chinese characters using Pinyin 

conversion is supported.

• Standard system application
• Kana-Kanji/Pinyin conversion

01.46.*** 1.280S

Special function switch
• GT SoftGOT2000 (Multiple channels) supports the 

backup/restoration.

• Standard system application
• Backup/restoration

01.47.*** 1.285X

Added and edited function Version of application/BootOS

Version 
correspondi
ng with GT 
Designer3
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12.17.5 GOT functions

■1 Basic functions
(1) Utility function

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3

- (first edition) Standard system application 01.00.*** 1.100E

The wireless LAN setting is added.

• Standard system application
• Wireless LAN

01.02.***
1.108N

BootOS D

The license management for the MES interface 
function is supported. BootOS D 1.108N

The brightness adjustment mode setting has been 
added.

Standard system application 01.03.***
1.112S

BootOS E

The POWER LED setting has been added. Standard system application 01.03.*** 1.112S

• The operation button has been added to the 
operation log list screen.

• Displaying the operation log screen in a reduced 
size is supported.

Standard system application 01.03.*** 1.112S

The R motion monitor is supported.
• Standard system application
• R motion monitor

01.04.*** 1.117X

The CNC monitor is supported.
• Standard system application
• CNC Monitor

01.04.*** 1.117X

The CNC data I/O is supported.
• Standard system application
• CNC Data I/O

01.04.*** 1.117X

The CNC machining program edit is supported.
• Standard system application
• CNC Manufacturing Program Editor

01.04.*** 1.117X

The recipe operation is supported. Standard system application 01.04.*** 1.117X

Deleting the label name resolution file is supported. Standard system application 01.04.*** 1.117X

GT21 supports the backup/restoration.
• Standard system application
• Backup/restoration

01.05.*** 1.118Y

The IP filter setting is supported.
Standard system application 01.06.***

1.122C
CoreOS H

The system launcher setting is supported.
• Standard system application
• System launcher

01.08.*** 1.126G

The iQSS utility setting is supported.
• Standard system application
• iQSS utility

01.08.*** 1.126G

The motion program editor is supported.
• Standard system application
• Motion Program Editor

01.10.*** 1.130L

The motion program I/O is supported.
• Standard system application
• Motion Program Input/Output

01.10.*** 1.130L

Displaying information on the station connected to 
the GOT (wireless LAN access point) is supported.

• Standard system application
• Wireless LAN

01.14.***
1.144A

BootOS T

The license management for the GOT Mobile 
function is supported.

• Standard system application
• GOT Mobile Setting

01.14.***
1.144A

CoreOS L

The GOT Mobile information is supported. Standard system application 01.15.*** 1.150G

The file manager is supported.
• Standard system application
• File Manager

01.15.*** 1.150G

The CNC monitor 2 is supported.
• Standard system application
• CNC Monitor 2

01.16.*** 1.155M

The drive recorder is supported.
• Standard system application
• Drive Recorder

01.16.*** 1.155M
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(2) Project function

The ANDON connection is supported.
• Standard system application
• GOT Mobile Setting

01.17.*** 1.160S

The CC-Link IE Field Network diagnostics is 
supported.

• Standard system application
• CC-Link IE Field Network diagnostics

01.18.*** 1.165X

The system launcher (servo network) is supported.
• Standard system application
• System Launcher (Basic)
• System Launcher (Servo Network)

01.20.*** 1.175H

The GOT Mobile function supports the file manager.
• Standard system application
• GOT Mobile Setting

01.20.*** 1.175H

The SRAM management function supports recipe 
data. • Standard system application 01.24.*** 1.190Y

The servo amplifier graph is supported.
• Standard system application
• Servo amplifier graph

01.25.*** 1.195D

GT21 supports the IP filter settings. Standard system application 01.25.*** 1.195D

The GOT Mobile function supports file manipulations.
• Standard system application
• GOT Mobile Setting

01.25.*** 1.195D

The GOT Mobile function supports disconnecting the 
clients by operating the GOT.

• Standard system application
• GOT Mobile Setting

01.26.*** 1.200J

The file print is supported.
• Standard system application
• File Print

01.26.*** 1.200J

The network drive settings are supported.

• Standard system application
• Network Drive

01.27.***

1.205P
CoreOS L

BootOS AK

File print
• Printing a report file in the network drive is 

supported.

• Standard system application
• File Print

01.27.*** 1.205P

File manager
• Manipulating the folders and files in the network 

drive is supported.

• Standard system application
• File Manager

01.27.*** 1.205P

The SRAM management function supports 
displaying information on the data saved by the 
internal device retention function.

Standard system application 01.29.*** 1.215Z

GT2107-W supports the operation log information 
window. Standard system application 01.38.*** 1.245F

GS21-W-N supports the VNC server screen.
• Standard system application
• VNC Server

01.39.*** 1.250L

GS21-W-N supports the license management 
screen. Standard system application 01.39.*** 1.250L

GS21-W-N supports the operation log information 
screen. Standard system application 01.39.*** 1.250L

The CC-Link IE TSN diagnostics is supported. Standard system application 01.42.*** 1.265B

GT SoftGOT2000 supports [ANDON connection] and 
[GOT Mobile information]. Standard system application 01.42.*** 1.265B

GT SoftGOT2000 (Multiple channels) supports the 
backup/restoration.

• Standard system application
• Backup/restoration

01.47.*** 1.285X

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3

- (first edition) Standard system application 01.00.*** 1.100E

The screen gesture function supports the key code 
(FF91h) for performing the full scale display (100%). Standard system application 01.01.*** 1.104J

The screen gesture function supports the graphics 
accelerator.

• Standard system application
• Graphic Acceleration Driver

01.03.***
1.112S

CoreOS E

Screen switching while the screen is being touched is 
supported. Standard system application 01.03.*** 1.112S

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3
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(3) Figures and objects

Automatically creating a recipe file (*.G2P) by 
converting an advanced recipe file (*.G1P) is 
supported.

Standard system application 01.03.*** 1.112S

Assigning a security key is supported.
Standard system application 01.06.***

1.122C
BootOS J

Specifying the unit of the drive free space is 
supported. Standard system application 01.17.*** 1.160S

The recipe special control is supported. Standard system application 01.17.*** 1.160S

The comment group supports Windows fonts. Standard system application 01.18.*** 1.165X

The operator authentication supports the following 
settings.
• Password requirements
• Password expiration prenotification
• Password change notification at the next login
• Enabling or disabling an operator account

• Standard system application
• Operator Authentication

01.20.*** 1.175H

The operator authentication supports the sub 
administrator setting.

• Standard system application
• Operator Authentication

01.23.*** 1.185T

A setting to display or hide the title bar of a user-
created key window is supported.

• Standard system application
• Key Window Design Information

01.23.*** 1.185T

The operation log function supports recording file 
print operations. • Standard system application 01.26.*** 1.200J

The hard copy function supports Ethernet printers.
• Standard system application 01.26.***

1.200J
BootOS AJ

Operator authentication
• The operator authentication with a USB device is 

supported.

• Standard system application
• Operator Authentication

01.27.*** 1.205P

The hard copy function supports Ethernet printers 
(PCL5). Standard system application 01.29.*** 1.215Z

The operation log function supports recording the 
operator name substituted by a character string 
stored in the device.

Standard system application 01.32.*** 1.225K

Operator authentication
• Saving the password history (up to 5 passwords) set 

for the operator authentication is supported.

• Standard system application
• Operator Authentication

01.34.*** 1.235V

Operation log
• Recording the change in the password for operator 

authentication is supported.
• Recording the vision sensor monitor at startup is 

supported.

Standard system application 01.34.*** 1.235V

GT2107-W supports the operation log function. Standard system application 01.38.*** 1.245F

GS21-W-N supports the VNC server function.
• Standard system application
• VNC Server

01.39.*** 1.250L

GS21-W-N supports the operation log function. Standard system application 01.39.*** 1.250L

Standard key windows that support KANA-KANJI 
conversion are supported. Standard system application 01.45.*** 1.275M

Hard copy
• Outputting PDF format files is supported.
• Specifying an output target screen is supported.
• Outputting multiple screen images is supported.

• Standard system application
• Hard copy PDF output function

01.47.*** 1.285X

Switching to secure mode for security keys is 
supported.

Standard system application 01.49.***
1.295H

BootOS AD

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3

- (first edition) Standard system application 01.00.*** 1.100E

The KANA-KANJI conversion for the text input is 
supported.

• Standard system application
• KANA-KANJI Conversion

01.01.*** 1.104J

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3
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(4) Standard font

Printing reports is supported.
• Standard system application
• Report

01.01.*** 1.104J

The slider is supported. Standard system application 01.02.*** 1.108N

Line, freeform line, rectangle, polygon, circle, and 
piping support the display/hide control. Standard system application 01.03.*** 1.112S

The objects on the key window support the following 
fonts.
• [6x8dot]
• [12dot Standard]
• [Outline Kaisho]
• [Outline Gothic]

Standard system application 01.03.*** 1.112S

The document display function supports the graphics 
accelerator.

• Standard system application
• Graphic Acceleration Driver

01.03.***
1.112S

CoreOS E

GT21 supports the slider. Standard system application 01.08.*** 1.126G

The text print is supported. (Not applicable to GT21) Standard system application 01.10.*** 1.130L

GT21 supports the text print. Standard system application 01.12.*** 1.134Q

The table is supported. Standard system application 01.14.*** 1.144A

The hyperlink is supported. Standard system application 01.14.*** 1.144A

GT21 supports the graphical meter. Standard system application 01.18.*** 1.165X

The document display supports the display of a PDF 
file without conversion to JPEG format.

• Standard system application
• Document Display (PDF)

01.20.*** 1.175H

Making the background of a logo text transparent is 
supported. Standard system application 01.25.*** 1.195D

The parts display supports automatic updates of 
image files used as the parts. Standard system application 01.37.*** 1.245F

The parts movement supports movement in a circular 
direction. Standard system application 01.37.*** 1.245F

GT SoftGOT2000 supports the hyperlink. Standard system application 01.42.*** 1.265B

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3

- (first edition)

Standard font
• Japanese
• Chinese (Simplified)
• Chinese (Traditional)

01.00.*** 1.100E

- (first edition) True Type numerical font 01.00.*** 1.100E

The easily-distinguishable font for the 
numeral zero and the capital letter I is 
supported.

Standard font
• Japanese
• Chinese (Simplified)
• Chinese (Traditional)

01.10.*** 1.130L

Added and edited function Version of application/BootOS Version corresponding 
with GT Designer3
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■2 Extended function

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3

Base screen size 
expansion

Creating a base screen larger than the GOT 
screen is supported. Base Screen Size Expansion 01.32.*** 1.225K

Graphics accelerator
The function to smooth the operations of the 
screen gesture function and the document 
display function is supported.

Graphic Acceleration Driver 01.03.***
1.112S

CoreOS E

Standard font - (first edition)

Standard font
• Japanese
• Chinese (Simplified)
• Chinese (Traditional)

01.00.*** 1.100E

Outline font (Gothic)

- (first edition)

Gothic
• Alphanumeric characters /KANA
• Japanese (Kanji)
• Chinese (Simplified)
• Chinese (Traditional)
• Hangul

01.00.*** 1.100E

Character code GBK for Simplified Chinese is 
supported.

Gothic
• Chinese (Simplified)

01.10.*** 1.130L

Outline font (Square 
style)

- (first edition)

Kaisho
• Alphanumeric characters /KANA
• Japanese (Kanji)
• Chinese (Simplified)
• Chinese (Traditional)
• Hangul

01.00.*** 1.100E

Character code GBK for Simplified Chinese is 
supported.

Kaisho
• Chinese (Simplified)

01.10.*** 1.130L

SoftGOT-GOT Link 
Function

- (first edition) SoftGOT-GOT Link Function 01.00.*** 1.100E

Under the authorization control of the GOT 
network interaction function, connecting 
multiple GT SoftGOT2000 modules to one 
GOT is supported.

SoftGOT-GOT Link Function 01.14.*** 1.144A

• Synchronization of the built-in memory 
(SRAM) is supported.

• Selecting the timing to synchronize the 
resource data is supported.

SoftGOT-GOT Link Function 01.33.*** 1.230Q

Selecting the timing to synchronize the project 
data is supported. SoftGOT-GOT Link Function 01.36.*** 1.240A

System launcher

The system launcher is supported. System Launcher 01.08.*** 1.126G

Starting the drive recorder is supported. System Launcher 01.16.*** 1.155M

Starting the sequence program monitor (R 
ladder), the R motion monitor, and the CNC 
monitor 2 is supported.

System Launcher 01.19.*** 1.170C

Starting the system launcher (servo network) 
is supported. System Launcher 01.20.*** 1.175H

CR800-R(R16RTCPU) is supported. System Launcher 01.21.*** 1.178L

Starting the servo amplifier graph is 
supported. System Launcher 01.25.*** 1.195D

• CR800-Q(Q172DSRCPU) is supported.
• Displaying the product information list and 

outputting product information to files are 
supported.

System Launcher 01.27.*** 1.205P

• The CC-Link IE TSN connection is 
supported.

• RnPSFCPU is supported.
System Launcher

01.32.*** 1.225K

The CC-Link IE TSN connection is supported. System Launcher (Servo Network)

GT SoftGOT2000 (Multiple channels) is 
supported. - - 1.265B
12 - 852 12. APPENDICES
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iQSS utility

The iQSS utility is supported. iQSS Utility 01.08.*** 1.126G

RCPU is supported. iQSS Utility 01.20.*** 1.175H

Profile data has been added. iQSS Utility 01.32.*** 1.225K

FX5U, FX5UC, and FX5UJ are supported. iQSS Utility 01.45.*** 1.275M

Kana-Kanji/Pinyin 
conversion function
(formerly, KANA KANJI 
conversion function)

KANA-KANJI conversion function is 
supported. KANA-KANJI Conversion 01.01.*** 1.104J

The Pinyin conversion function is supported. Kana-Kanji/Pinyin Conversion 01.46.*** 1.280S

Wireless LAN function

Wireless LAN function is supported.
Wireless LAN 01.02.***

1.108N
BootOS D

The operation mode to make the GOT 
operate as a wireless LAN access point is 
supported.

Wireless LAN 01.14.***
1.144A

BootOS D

Sequence program 
monitor (ladder) - (first edition)

Sequence Program Monitor
• Sequence program monitor 

(Common)
01.00.*** 1.100E

GOT Platform Library 01.00.*** 1.100E

GOT Function Expansion Library 01.00.*** 1.100E

Sequence program 
monitor (iQ-R/iQ-L 
ladder)
(formerly sequence 
program monitor (iQ-R 
ladder))

The sequence program monitor (R ladder) is 
supported.

Sequence Program Monitor
• Sequence Program Monitor(R 

Ladder)
01.09.*** 1.127H

GOT Platform Library 01.09.*** 1.127H

GOT Function Expansion Library 01.09.*** 1.127H

GOT Function Expansion Library 
(Additional/MELSEC iQ-R) 01.09.*** 1.127H

Editing programs with the sequence program 
monitor (R ladder) is supported.

Sequence Program Monitor
• Sequence Program Monitor(R 

Ladder)
01.18.*** 1.165X

GOT Platform Library 01.18.*** 1.165X

GOT Function Expansion Library 01.18.*** 1.165X

GOT Function Expansion Library 
(Additional/MELSEC iQ-R) 01.18.*** 1.165X

The function name has been changed to the 
sequence program monitor (iQ-R ladder).

Sequence Program Monitor
• Sequence Program Monitor(iQ-R 

Ladder)
01.23.*** 1.185T

• The function name has been changed to the 
sequence program monitor (iQ-R/iQ-L 
ladder)

• LHCPU is supported.

Sequence Program Monitor
• Sequence Program Monitor (iQ-R/

iQ-L Ladder)
01.36.*** 1.240A

Displaying a program that uses a macro type 
function block that is not protected by the 
block password is supported.

Sequence Program Monitor
• Sequence Program Monitor (iQ-R/

iQ-L Ladder)
01.42.*** 1.265B

Sequence program 
monitor (SFC) - (first edition)

Sequence Program Monitor
• Sequence program monitor (SFC)

01.00.*** 1.100E

GOT Platform Library 01.00.*** 1.100E

GOT Function Expansion Library 01.00.*** 1.100E

Sequence program 
monitor (iQ-F ladder) - (first edition)

Sequence Program Monitor
• Sequence program monitor (iQ-F 

ladder)
01.39.*** 1.255R

GOT Platform Library 01.39.*** 1.255R

GOT Function Expansion Library 01.39.*** 1.255R

GOT Function Expansion Library 
(Additional/MELSEC iQ-F) 01.39.*** 1.255R

FX Ladder Monitor 
Function - (first edition) FX Ladder Monitor Function 01.00.*** 1.100E

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
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Backup/restoration

- (first edition) Backup/Restoration 01.00.*** 1.100E

The backup/restoration for RCPU and CNC 
C70 is supported. Backup/Restoration 01.04.*** 1.117X

• The backup/restoration for the Motion CPU 
(MELSEC iQ-R series) is supported.

• GT21 supports the backup/restoration.
Backup/Restoration 01.05.*** 1.118Y

Retaining the file registers of a PLC at 
restoration is supported. Backup/Restoration 01.08.*** 1.126G

The backup/restoration for R64MTCPU is 
supported. Backup/Restoration 01.20.*** 1.175H

The backup/restoration for CR800-
R(R16RTCPU) and CR800-D is supported. Backup/Restoration 01.21.*** 1.178L

The backup/restoration for MELSEC iQ-F is 
supported. Backup/Restoration 01.23.*** 1.185T

• CR800-Q(Q172DSRCPU) is supported.
• The connection to an inverter or servo 

amplifier through a QCPU or LCPU is 
supported.

Backup/Restoration 01.27.*** 1.205P

When the RCPU No.1 does not support this 
function, the backup/restoration for the RCPU 
No.2 or later will be supported.

Backup/Restoration 01.42.*** 1.265B

GT SoftGOT2000 (Multiple channels) is 
supported. Backup/Restoration 01.47.*** 1.285X

Gateway (Server and 
client function)

- (first edition)
Gateway
• Gateway (Server, Client)

01.00.*** 1.100E

GT SoftGOT2000 supports the server 
function.

Gateway
• Gateway (Server, Client)

01.39.*** 1.255R

GENESIS64 is added to the software that can 
be used as a client

Gateway
• Gateway (Server, Client)

01.42.*** 1.265B

Gateway (Mail send 
function)

- (first edition)
Gateway
• Getaway Server (Mail)

01.00.*** 1.100E

The SMTP server authentication is 
supported.

Gateway
• Getaway Server (Mail)

01.18.***

1.165XThe SMTP server authentication through a 
password of 129 or more characters is 
supported.

Gateway
• Getaway Server (Mail)

01.18.***

BootOS AA

DNS servers are supported. Gateway
• Getaway Server (Mail)

01.43.***
1.270G

BootOS AX

FTP server 
function(Gateway)

- (first edition)
Gateway
• Gateway (FTP Server)

01.00.*** 1.100E

GT21 supports this function. - 01.14.*** 1.144A

The number of connectable FTP clients has 
been changed to 4.

Gateway
• Gateway (FTP Server)

01.25.*** 1.195D

Gateway (File Transfer 
(FTP Client)function)

- (first edition)
Gateway
• Gateway (FTP Client)

01.00.*** 1.100E

Access to the FTP server function of a 
MITSUBISHI PLC is supported.

Gateway
• Gateway (FTP Client)

01.08.*** 1.126G

GT21 supports this function. - 01.14.*** 1.144A

The function name has been changed to the 
file transfer function (FTP transfer). File Transfer 01.16.*** 1.155M

The maximum number of connectable FTP 
servers has been changed to 64. File Transfer 01.23.*** 1.185T

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
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Barcode

- (first edition) Barcode 01.00.*** 1.100E

Connection via the standard RS422/485 
interface is supported. Barcode 01.08.*** 1.126G

The system application name has been 
changed. Bar Code (Serial) (formerly Barcode) 01.20.*** 1.175H

The barcode function supports data entry 
from a USB barcode reader. Bar Code (USB) 01.20.*** 1.175H

Specifying values as the header or terminator 
is supported. Bar Code (Serial) 01.26.*** 1.200J

RFID

- (first edition) RFID 01.00.*** 1.100E

Connection via the standard RS422/485 
interface is supported. RFID 01.08.*** 1.126G

Specifying values as the header or terminator 
is supported. RFID 01.26.*** 1.200J

PC Remote Operation 
function (Serial)

- (first edition) PC Remote Operation (Serial) 01.00.*** 1.100E

Remote Personal Computer Operation Driver 
(TSC-DD) is supported. PC Remote Operation (Serial) 01.02.*** 1.108N

The video/RGB display object is supported.
PC Remote Operation (Serial) 01.10.***

1.130L
BootOS N

Remote Personal Computer Operation Driver 
(DMT-DD) is supported. PC Remote Operation (Serial) 01.26.*** 1.200J

PC Remote Operation 
function (Ethernet)

- (first edition) PC Remote Operation (Ethernet) 01.00.*** 1.100E

• GOT Graphic Ver.2 is supported.
• The full screen mode is supported.

PC Remote Operation (Ethernet) 01.32.*** 1.225K

VNC Server function

- (first edition) VNC server 01.00.*** 1.100E

The authorization control of the GOT network 
interaction function is supported. VNC server 01.14.*** 1.144A

The VNC server function is supported by 
GT2107-W. VNC server 01.20.*** 1.175H

GS21-W-N supports the VNC server function. VNC server 01.39.*** 1.250L

Video Display function - (first edition)
Video/Multimedia
• Video/RGB

01.00.*** 1.100E

RGB Display function - (first edition)
Video/Multimedia
• Video/RGB

01.00.*** 1.100E

Multimedia function - (first edition)
Video/Multimedia
• Multimedia

01.00.*** 1.100E

External I/O function / 
Operation Panel function

- (first edition) External I/O 01.00.*** 1.100E

The operation panel function is supported. External I/O / Operation Panel 01.02.*** 1.108N

Report function

• The file output is supported.
• Outputting the operation log is supported.

Report function 01.26.***

1.200J

Ethernet printers are supported.
Report function 01.26.***

BootOS AJ

Ethernet printers (PCL5) are supported.
Report function 01.29.***

1.215Z
BootOS AM

• Outputting alarms (when checked) is 
supported.

• The process notification device is supported.
Report function 01.43.*** 1.270G

Sound Output function - (first edition) Sound Output. 01.00.*** 1.100E

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
12. APPENDICES
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GOT network interaction 
function

The GOT network interaction function is 
supported. GOT Network Interaction 01.14.*** 1.144A

Obtaining the authorization of the GOT 
network interaction function together with that 
of the VNC server function is supported.

GOT Network Interaction 01.19.*** 1.170C

The configuration with GT SoftGOT2000 as 
the master GOT is supported. - - 1.265B

GOT Mobile function

The GOT Mobile function is supported.
GOT Mobile Setting 01.14.***

1.144A
CoreOS L

The disconnect screen is supported. GOT Mobile Setting 01.32.*** 1.225K

The configuration with GT SoftGOT2000 as 
the server is supported. - - 1.265B

Displaying an overlap window or 
superimpose window is supported. GOT Mobile Setting 01.46.*** 1.280S

Device Data Transfer - (first edition) Device Data Transfer 01.00.*** 1.100E

Device monitor

- (first edition)
Device monitor 01.00.*** 1.100E

GOT Platform Library 01.00.*** 1.100E

RCPU is supported.
Device monitor 01.12.*** 1.134Q

GOT Platform Library 01.12.*** 1.134Q

RnSFCPU is supported.
Device monitor 01.14.*** 1.144A

GOT Platform Library 01.14.*** 1.144A

CR800-R(R16RTCPU) and CR800-D are 
supported.

Device monitor 01.21.*** 1.178L

GOT Platform Library 01.21.*** 1.178L

FX5UC is supported.
Device monitor 01.27.*** 1.215Z

GOT Platform Library 01.29.*** 1.215Z

• LHCPU is supported.
• The Motion CPU (MELSEC iQ-R series) is 

supported.

Device monitor 01.36.*** 1.240A

GOT Platform Library 01.36.*** 1.240A

When connected with the RCPU, LHCPU, 
MELSEC iQ-F, Motion CPU (MELSEC iQ-R 
series), robot controller (MELSEC iQ-R 
series), or CNC C80, displaying the device 
comments is supported.

Device monitor 01.42.*** 1.265B

GOT Platform Library 01.42.*** 1.265B

Network monitor

- (first edition) Network monitor 01.00.*** 1.100E

RCPU is supported. Network monitor 01.04.*** 1.117X

• The CC-Link IE TSN connection is 
supported.

• RnPCPU and RnPSFCPU are supported.
Network monitor 01.32.*** 1.225K

Log Viewer

- (first edition) Log Viewer 01.00.*** 1.100E

BOX data logger is supported. Log Viewer 01.01.*** 1.104J

RCPU is supported. Log Viewer 01.04.*** 1.117X

CNC C70 is supported. Log Viewer 01.12.*** 1.134Q

MELSEC iQ-F is supported. Log Viewer 01.23.*** 1.185T

LHCPU is supported. Log Viewer 01.36.*** 1.240A

RnSFCPU is supported. Log Viewer 01.40.*** 1.260W

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
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Intelligent module 
monitor

- (first edition) Intelligent module monitor 01.00.*** 1.100E

RCPU is supported. Intelligent module monitor 01.04.*** 1.117X

Q26DHCCPU-LS is supported. Intelligent module monitor 01.15.*** 1.150G

RJ72GF15-T2, RD77GF, and RD77MS are 
supported. Intelligent module monitor 01.17.*** 1.160S

CR800-R(R16RTCPU) is supported. Intelligent module monitor 01.21.*** 1.178L

• The CC-Link IE TSN connection is 
supported.

• RnPCPU and RnPSFCPU are supported.
Intelligent module monitor 01.32.*** 1.225K

Servo amplifier monitor - (first edition) Servo amplifier monitor 01.00.*** 1.100E

R motion monitor

The R motion monitor is supported. R motion monitor 01.04.*** 1.117X

Transition to the system launcher is 
supported. R motion monitor 01.19.*** 1.170C

The CC-Link IE TSN connection is supported. R motion monitor 01.32.*** 1.225K

Q motion monitor
- (first edition) Q motion monitor 01.00.*** 1.100E

Q26DHCCPU-LS is supported. Q motion monitor 01.15.*** 1.150G

CNC monitor The CNC monitor is supported. CNC Monitor 01.04.*** 1.117X

CNC data I/O The CNC data I/O is supported.
CNC Data I/O 01.04.*** 1.117X

GOT Platform Library 01.04.*** 1.117X

CNC machining program 
edit

The CNC machining program edit is 
supported.

CNC Manufacturing Program Editor 01.04.*** 1.117X

GOT Platform Library 01.04.*** 1.117X

Motion program editor

The motion program editor is supported. Motion Program Editor 01.10.*** 1.130L

RnMTCPU is supported. Motion Program Editor 01.23.*** 1.185T

GT2510-WX supports the motion program 
editor. Motion Program Editor 01.33.*** 1.230Q

GT2512-WX supports the motion program 
editor. Motion Program Editor 01.39.*** 1.250L

Motion program I/O

The motion program I/O is supported. Motion Program Input/Output 01.10.*** 1.130L

RnMTCPU is supported. Motion Program Input/Output 01.23.*** 1.185T

GT2510-WX supports the motion program I/
O. Motion Program Input/Output 01.33.*** 1.230Q

GT2512-WX supports the motion program I/
O. Motion Program Input/Output 01.39.*** 1.250L

FX list editor - (first edition) List editor for FX 01.00.*** 1.100E

File manager The file manager is supported. File Manager 01.15.*** 1.150G

File print The file print is supported. File print 01.26.*** 1.200J

Document Display

- (first edition) Document Display 01.00.*** 1.100E

The system application name has been 
changed.

Document Display (Document 
Converter) (formerly Document 
Display)

01.20.*** 1.175H

Displaying a PDF file as-is is supported. Document Display (PDF) 01.20.*** 1.175H

The search and bookmark functions for PDF 
files are supported. PDF Search/bookmark Function 01.23.*** 1.185T

Selecting a drive to store documents is 
supported.

Document Display (Document 
Converter) 01.28.*** 1.210U

Document Display (PDF) 01.28.*** 1.210U

Displaying a page by searching for a keyword 
is supported. Document Display (PDF) 01.28.*** 1.210U

Video/RGB display 
object The video/RGB display object is supported.

Video/RGB (Object) 01.10.***
1.130L

BootOS N

File transfer function 
(GOT internal transfer)

The file transfer function (GOT internal 
transfer) is supported. File Transfer 01.16.*** 1.155M

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
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Drive recorder

The drive recorder is supported. Drive Recorder 01.16.*** 1.155M

MELSERVO-JE-*B is supported. Drive Recorder 01.17.*** 1.160S

MR-J4-GF(-RJ) is supported. Drive Recorder 01.23.*** 1.185T

Displaying waveform data by type is 
supported. Drive Recorder 01.28.*** 1.210U

The CC-Link IE TSN connection is supported. Drive Recorder 01.32.*** 1.225K

MR-J5-G(-RJ), MR-J5W□-G, and MR-JET-G 
are supported. Drive Recorder 01.37.*** 1.245F

GT SoftGOT2000 (Multiple channels) is 
supported. - - 1.265B

MR-J5-B and MR-J5D-G are supported. Drive Recorder 01.47.*** 1.285X

CNC monitor 2

The CNC monitor 2 is supported. CNC Monitor 2 01.16.*** 1.155M

GT27-V and GT25-V support the CNC 
monitor 2. CNC Monitor 2 01.18.*** 1.165X

• GT2505-V and GT2505HS-V support the 
CNC monitor 2.

• GT27-X supports QWERTY keyboards.
CNC Monitor 2 01.27.*** 1.205P

Recipe display (record 
list) The recipe display (record list) is supported. Recipe Display (Record List) 01.16.*** 1.155M

CC-Link IE Field Network 
diagnostics

The CC-Link IE Field Network diagnostics is 
supported.

CC-Link IE Field Network 
diagnostics 01.18.*** 1.165X

Servo amplifier graph

The servo amplifier graph is supported. Servo amplifier graph 01.25.*** 1.195D

Displaying waveform data by type is 
supported. Servo amplifier graph 01.28.*** 1.210U

The CC-Link IE TSN connection is supported. Servo amplifier graph 01.32.*** 1.225K

Displaying the axis name of the Motion 
module is supported. Servo amplifier graph 01.40.*** 1.260W

GT SoftGOT2000 (Multiple channels) is 
supported. - - 1.265B

R motion SFC monitor The R motion SFC monitor is supported. R motion SFC monitor 01.33.*** 1.230Q

Vision Sensor Monitor

The vision sensor monitor is supported. Vision Sensor Monitor 01.34.*** 1.235V

• Editing the graphic parameters is supported.
• Displaying the total determination results is 

supported.
• The hard copy function is supported.

Vision Sensor Monitor 01.42.*** 1.265B

• Multi-connection is supported.
• Video image rotation is supported.

Vision Sensor Monitor 01.45.*** 1.275M

Item Added and edited function Version of application/BootOS
Version 

corresponding 
with GT Designer3
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0Warranty

Please check the following product warranty details before using this product.

If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the 
gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company. 
However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at the customer's 
discretion. 
Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-site that involves replacement of the 
failed module.

The gratis warranty term of the product shall be for thirty-six (36) months after the date of purchase or delivery to a designated 
place. 
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest 
gratis warranty term after manufacturing shall be forty-two (42) months. 
The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

• Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's 
hardware or software design.

• Failure caused by unapproved modifications, etc., to the product by the user.
• When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, 

judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had 
been provided.

• Failure that could have been avoided if consumable parts designated in the instruction manual had been correctly serviced or 
replaced.

• Replacing consumable parts such as a battery, backlight, and fuse.
• Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as 

earthquakes, lightning, wind and water damage.
• Failure caused by reasons that could not be predicted by scientific technology standards at the time of shipment from 

Mitsubishi.
• Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user.

(1) Gratis Warranty Term

(2) Gratis Warranty Range
(a) The customer shall be responsible for the primary failure diagnosis unless otherwise specified. 

If requested by the customer, Mitsubishi Electric Corporation or its representative firm may carry out the primary failure 
diagnosis at the customer’s expense. 
The primary failure diagnosis will, however, be free of charge should the cause of failure be attributable to Mitsubishi Electric 
Corporation.

(b) The range shall be limited to normal use within the usage state, usage methods, and usage environment, etc., which follow the 
conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.

(c) Even within the gratis warranty term, repairs shall be charged in the following cases.

Gratis Warranty Term and Gratis Warranty Range

(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued. 
Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.

(2) Mitsubishi shall not accept a request for product supply (including spare parts) after production is discontinued.

Onerous repair term after discontinuation of production

Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. 
Note that the repair conditions at each FA Center may differ.

Overseas service

Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to: 
Exclusion of loss in opportunity and secondary loss from warranty liability

The specifications given in the catalogs, manuals, or technical documents are subject to change without prior notice.
Changes in product specifications

(1) In using the Mitsubishi graphic operation terminal, the usage conditions shall be that the application will not lead to a major accident 
even if any problem or fault should occur in the graphic operation terminal device, and that backup and fail-safe functions are 
systematically provided outside of the device for any problem or fault.

(2) The Mitsubishi graphic operation terminal has been designed and manufactured for applications in general industries, etc. 
Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by 
respective power companies, and applications in which a special quality assurance system is required, such as for Railway 
companies or Public service shall be excluded from the graphic operation terminal applications. 
In addition, applications in which human life or property could be greatly affected, such as in aircraft, medical, railway applications, 
incineration and fuel devices, manned transportation equipment, recreation and amusement devices, safety devices, shall also be 
excluded from the graphic operation terminal. 
Even for the above applications, however, Mitsubishi Electric Corporation may consider the possibility of an application, provided 
that the customer notifies Mitsubishi Electric Corporation of the intention, the application is clearly defined and any special quality is 
not required, after the user consults the local Mitsubishi representative.

Product application

(1) Damages caused by any cause found not to be the responsibility of Mitsubishi.
(2) Loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi products.
(3) Special damages and secondary damages whether foreseeable or not, compensation for accidents, and compensation for 

damages to products other than Mitsubishi products.
(4) Replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.
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